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Esplora
Welcome to Automation Anywhere Automation 360. Review these pages to get an introduction to our
latest RPA and Intelligent Automation platform.

Panoramica

Automation 360 is the RPA industry's first purely web-based Intelligent Automation platform that is cloud-
native. Delivered in the Cloud or On-Premises, Automation 360 is designed for ease of use by all types of
users across technical skill levels. The platform enables businesses of all sizes to achieve unprecedented
scale with enterprise-class security, data privacy, and reduced time to value and costs of ownership. With
Automation 360, businesses can also leverage built-in artificial intelligence (AI) capabilities and easily
integrate third-party AI solutions, such as computer vision, natural language processing, and predictive
modeling—all with the simplicity of drag-and-drop AI into any automation workflow.
The Automation 360 platform also includes attended automation and plug-ins that enable business users
to automate tasks from within their business applications such as Microsoft Excel and Salesforce. This
capability makes automation of front-office processes easier, faster, and more cost-efficient.
Automation 360 is available globally and in 10 languages, including English, French, German, Japanese,
Korean, Italian, Portuguese, Russian, Spanish, Simplified Chinese, and Traditional Chinese.

Available products

The Automation 360 platform includes the following offerings:
• Automation 360 delivered in the cloud, hosted by Automation Anywhere with no client installation or

additional infrastructure required
• Automation 360, the full platform delivered On-Premises
• Automation 360 Free Trial, with 30 days to try the cloud-based offering with full tech support included

during the trial period
• Community Edition, a free web-based option for users to experience a wide-range of Enterprise A2019

bot creation capabilities

Documentation on previous releases

For documentation on previous versions of our products, see the PDFs available on these pages:
• Automation 360
• Enterprise 11.x
• Process Discovery
• Integrations
• IQ Bot 11x
• Mobile apps
• Human-Bot Collaboration 11.x

More resources

• Formazione su Automation 360: Get trained and certified on Automation 360 (A-People login required)
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• Industry first bot security program

Concetti correlati
Note sulla versione Automation 360 alla pagina 63
Esamina le nuove capacità, le modifiche, le correzioni (problemi risolti), le correzioni di sicurezza, le
funzionalità obsolete e le limitazioni di ogni versione.
Informazioni su Automation 360 alla pagina 11
La piattaforma per forza lavoro digitale Automation Anywhere è la base per fornire automazione del lavoro
aziendale complesso in modo sicuro e su vasta scala. Automation 360 è una piattaforma per forza lavoro
digitale e RPA leader del settore che combina un'interfaccia utente di facile utilizzo con l'affidabilità di
classe enterprise e la sicurezza per consentire l'auto-automazione in tempo reale.
Security architecture alla pagina 23
Molte delle principali organizzazioni finanziarie del mondo si affidano alla piattaforma per forza lavoro
digitale sicura di Automation 360 per automatizzare le operazioni sensibili dal punto di vista della sicurezza.
Informazioni correlate
Automation Anywhere Bot Store
Automation 360 platform
What is RPA?
What is a CoE?
Automation Anywhere University: RPA Training and Certification (A-People login required)

Informazioni su Automation 360
La piattaforma per forza lavoro digitale Automation Anywhere è la base per fornire automazione del lavoro
aziendale complesso in modo sicuro e su vasta scala. Automation 360 è una piattaforma per forza lavoro
digitale e RPA leader del settore che combina un'interfaccia utente di facile utilizzo con l'affidabilità di
classe enterprise e la sicurezza per consentire l'auto-automazione in tempo reale.

Panoramica

Automation 360 è una piattaforma per forza lavoro digitale e RPA leader del settore che combina
un'interfaccia utente di facile utilizzo con l'affidabilità di classe enterprise e la sicurezza per consentire
l'auto-automazione in tempo reale. Offre agli utenti aziendali un'esperienza intuitiva basata su browser per
automatizzare rapidamente le attività e agli sviluppatori strumenti per realizzare l'automazione dei processi.
Automation 360 offre opzioni di distribuzione sia On-Premises che Cloud ed è la prima piattaforma che
fornisce RPA-as-a-Service come soluzione di automazione. Consente agli utenti di automatizzare le
applicazioni in diverse infrastrutture e settori come le organizzazioni di servizi bancari, telecomunicazioni e
di outsourcing dei processi aziendali (BPO).
Automation 360 fornisce funzionalità come le seguenti:
• Un'interfaccia intuitiva per creare bot e progettare flussi di lavoro di automazione dei processi aziendali.
• Supporto per più sistemi operativi, inclusi Windows, Linux e MacOS.
• Diverse viste di bot per facilitare la collaborazione: vista flusso per gli utenti aziendali, vista elenco per

gli sviluppatori e vista doppia per la collaborazione.
• Registratore che funziona su varie piattaforme come Microsoft Windows, Citrix, Web e SAP.
• Funzionalità di variabili avanzate e supporto per JavaScript, Python e VBScript.
• Un'architettura flessibile che consente di aggiungere nuovi pacchetti di comandi.
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Componenti di Automation 360

Automation Anywhere Robotic Interface
(AARI)

AARI è un'interfaccia di facile utilizzo che consente
agli utenti aziendali di collaborare con bots. Gli
utenti possono avviare automazioni di processo,
fornire feedback a bots per riprendere i processi e
inoltrare le richieste ad altri utenti per l'elaborazione
a valle. AARI consente all'azienda di sbloccare
nuove opportunità di automazione tra persone
e bots che la RPA non poteva affrontare in
precedenza.
Automation Anywhere Robotic Interface (AARI) alla
pagina 2106

RPA Workspace Uno spazio di lavoro basato sul web che fornisce
gli strumenti e le capacità per creare, caricare e
distribuire bots per automatizzare attività e processi
ripetitivi. Include quanto segue:
• Control Room
• Bot Runner
• Bot editor
• Bot Creator
• Credential Vault

RPA Workspace fornisce le seguenti capacità:
• Permette agli utenti di gestire, programmare ed

eseguire bots
• Permette la gestione degli utenti attraverso la

mappatura del ruolo Active Directory
• Permette agli utenti di gestire un gran numero di

Work Items attraverso la gestione del carico di
lavoro

Process Discovery An intelligent business solution that delivers a real-
time, data-driven map of your business to help you
uncover transformational process insights across
all applications, through each department, and for
every single task. Process Discovery follows the
human instead of process logs by using advanced
computer vision, machine learning, and artificial
intelligence to capture every step in every process
across every system. It requires zero integration,
is universally compatible, and provides the privacy
and security of an on-premises solution.

Privacy Enhanced Gateway Using Privacy Enhanced Gateway (PEG), enterprises
can confidently execute on their strategic business
initiatives by filtering their sensitive data in
a secure and scalable manner. PEG works by
redacting sensitive data that has been obtained
on customer's machines within their own network
before forwarding the data to the Process Discovery
cloud for analysis. As all traffic from the agents
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goes through PEG before leaving the customer's
perimeter, PEG removes personally identifiable
information (PII) and sensitive data.
Getting started with Privacy Enhanced Gateway alla
pagina 2300

Discovery Bot Una soluzione aziendale intelligente per le aziende
che fornisce agli utenti finali funzionalità per
scoprire opportunità di automazione utilizzando
il process discovery. Discovery Bot si concentra
sull'automazione dei processi acquisendo processi
di documenti, identificando opportunità da
processi incentrati sul business e dando priorità
alle opportunità in base al ROI e crea bots
automaticamente. Discovery Bot allinea i lavoratori
aziendali per scoprire le opportunità di automazione
che possono ottimizzare il ritorno sull'investimento
RPA.
Process discovery by using Discovery Bot alla pagina
2328

IQ Bot Una soluzione intelligente di elaborazione dei
documenti in grado di leggere ed elaborare vari
documenti complessi ed e-mail. IQ Bot combina
la RPA con diverse tecniche di IA per acquisire,
classificare ed estrarre in modo intelligente dati
semistrutturati e non strutturati, consentendo di
automatizzare i processi aziendali end-to-end basati
su documenti.
Installazione e aggiornamento Automation 360 IQ Bot
alla pagina 1066

Bot Insight Piattaforma di analisi che fornisce informazioni in
tempo reale, interattive e intelligenti sui processi
aziendali e sull'intelligence operativa. Bot Insight
utilizza la grande quantità di dati a livello di
contenuto e di produttività che i bots generano e
traduce i dati in idee attraverso dashboard generati
automaticamente e personalizzabili.
Business analytics through Bot Insight alla pagina
2953

Bot Store Marketplace online per bots e Digital Workers
pre-costruiti che funzionano sulla piattaforma
Automation 360. Accedi a Bot Store direttamente
dalla Control Room per scaricare o inviare bots e
packages.
Bot Store alla pagina 2944

Private Bot Store Un marketplace
bot interno sicuro
per un'azienda
per pubblicare e
condividere dettagli e
documentazione per
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tutti i bots sviluppati
internamente. I
dipendenti possono
facilmente scoprire
i comandi e i bots
interni da riutilizzare
oltre a tutti i bots dallo
Bot Store Automation
Anywhere.
Private Bot Store alla
pagina 61

L'immagine seguente mostra i componenti di Automation 360:
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Vantaggi

Time-to-value più rapido • Implementazione istantanea basata sul web
che consente di iniziare a sviluppare bots
rapidamente

• Un'interfaccia intuitiva che consente agli utenti
con diversi livelli di competenza di utilizzare
facilmente il prodotto e velocizzare il processo di
apprendimento

• Semplicità di collaborazione tra aziende, processi
e IT

Agilità aziendale • Aggiornamenti regolari per restare sempre
aggiornati su qualsiasi dispositivo, ovunque

• Continuità aziendale con disponibilità elevata e
ripristino di emergenza

• Scalabilità

Costo totale di proprietà (TCO) più basso • Nessun investimento aggiuntivo in infrastrutture
richiesto

• Un'unica piattaforma per il front office, il back
office e le applicazioni per i dipendenti

• Riduzione dei costi di manutenzione

Modelli di distribuzione
Automation 360 fornisce i seguenti modelli di distribuzione:

Cloud Automation 360 Cloud è un'offerta SaaS ospitata
da Automation Anywhere che fornisce un modello
di consumo semplice della piattaforma Automation
360 realizzato su un'architettura nativa per il cloud.
Con il servizio Automation 360 Cloud, la piattaforma
Automation 360, che comprende la Control Room
Automation 360 e le applicazioni (RPA Workspace,
IQ Bot, Bot Insight, AARI e Discovery Bot), è
ospitata da Automation Anywhere e accessibile
agli utenti attraverso un browser Web. I dispositivi
Bot Agent sui quali vengono eseguiti i bots e le
automazioni rimangono sull'infrastruttura del cliente
e si collegano in modo sicuro al servizio Automation
360 Cloud tramite HTTPS.

Abilitato al cloud In questo modello di distribuzione, i dati sono
ospitati On-Premises. Questo modello è adatto
ai clienti che devono attenersi a rigorose norme
regolamentari in cui la sovranità dei dati è
obbligatoria.

On-Premises with packages updates through
Cloud

With Automation Anywhere On-Premises with
packages updates through Cloud service, all
business, personal, and operational data is kept on
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and deployed from the server on-premises on the
customer network.

L'immagine seguente mostra i modelli di distribuzione per Automation 360:

Vedi anche Responsabilità operative Cloud alla pagina 26.

Guida al prodotto

Automation Anywhere uses a digital adoption platform to provide in-product user assistance (guides and
walkthroughs) and anonymously analyze product usage such as page views and feature clicks. This data is
used to inform user research and improve the overall experience of Automation Anywhere solutions.

Services performed • In-product guides and user notifications
• In-product educational spotlights
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• Informational tips and other contextual user
assistance elements within the product to help
onboard users

• Anonymized user analytics to understand usage
patterns of Automation Anywhere products

Data processed • Clicks on user interface elements within
Automation Anywhere products

• User ID in a form that does not disclose
the identity of the user (for example,
159:0a664495-7f3e-126a-817f-513aeedf003e)

• Web-browser type, web-browser version
• Server Control Room URL
• Language selected (English, Japanese, and so

on)
• User's first visit and last visit
• User's permissions settings
• List of features to which the user has access
• Product features that are used
• Automation Anywhere license type (Developer,

Attended User, and so on)
• Automation Anywhere product version number
• User provided ratings and feedback comments

on product features and functionality

Nota:  The digital adoption platform does not
receive the user's IP address or bot information
such as which bot was run and what the bot does.

Types of data captured Automation Anywhere captures the following three
types of data when using the digital adoption
platform:
• Event data

Includes click and focus events providing usage
metrics. This enables us to understand the
adoption of features and usage patterns to
inform future improvements to the experience of
our products.
Ad esempio:
• Clicking the Run Bot option
• Clicking the paths to open a bot in the Bot

editor
• Tabbing into a search input

Nota:  The platform does not collect any user-
entered text.
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• Page load data
Includes data captured as users navigate to
various parts of the web application, such as
root paths of links and page titles

Nota:  The platform does not collect any input
parameters sent through a link.

• Metadata
Includes metadata that is associated with
clicks and page loads when a user logs in to
Automation Anywhere products.
Metadata that is sent to the digital adoption
platform includes the following types of
information:
• Pseudonymized user ID
• Pseudonymized account ID
• Selected language
• Numero di build
• Browser version

Nota:  The platform explicitly does not:
• Record the screen
• Perform any sort of screen-scraping
• Capture data entered in any input field

Blocking the platform Blocking the digital adoption platform will block
in-product user assistance and important system
messages such as the following:
• Productivity boosts through targeted user

tutorials
• Targeted important announcements and direct

communications
• Opportunity for in-app direct feedback, requests,

and support
• In-app integration to Automation Anywhere

documentation and support
• Ability to see user behavior so that we can

proactively make improvements to the product

Guarda il seguente video per ulteriori informazioni su RPA:
Informazioni correlate
Automation 360 platform
What is RPA?
What are RPA bots
RPA for Business Process Outsourcing (BPO)
Automation Anywhere University: RPA Training and Certification (A-People login required)
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Panoramica di Control Room
La Control Room consente di gestire, programmare, eseguire e configurare diverse funzionalità di bots e
Bot Runners mediante una raccolta di servizi Web specializzati.

Componenti

La Control Room è un punto di gestione centralizzato per tutti i bots. A reverse proxy is responsible
for listening for remote connection requests and forwarding those requests to the correct specialized
service. The following figure shows the On-Premises Control Room components and general data center
interaction. I componenti della Control Room sono visualizzati in arancione e i componenti del data center
forniti dalla tua organizzazione sono visualizzati in blu. I componenti ospitati centralmente su cloud e gestiti
da Automation Anywhere come il server delle licenze sono mostrati in bianco.

In the data center, Control Room is installed on a server and configured to interact with the other data
center components.
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The Control Room includes objects that performs the following:
• Control Room reverse proxy is managed through the following functions:

• Control Room services
• Control Room messaging
• Control Room caching

• Elasticsearch
• Licensing

The Control Room required data center components include:
• Un server SQL con un database Control Room.
• A Server Message Block (SMB) file share

For Cloud Control Room architecture, see Cloud Control Room architecture image.

Centralized Automation Deployment

• Control Room acts as the single point of access and control for bot execution.
• Control Room provides bot upload and download features to facilitate seamless collaboration for end to

end business process automation by multiple users.
• All scheduling is managed by the Control Room. Bots are deployed on the Bot Runners either ad hoc

or on pre-defined schedules. Una volta creati i programmi, la Control Room seleziona automaticamente
e in modo intelligente i successivi aggiornamenti ai bots, senza necessità di modificare i programmi di
automazione.

Centralized Access Control

• Least Privilege and Access controls user access. They are implemented in the Control Room through
Role Based Access Control (RBAC).

• All Users and Roles are created and managed from the Control Room.

Collaboration Centralized Workforce Management

• Control Room dashboards provide a single view of the entire automation infrastructure.
• Control Room receives real time heartbeat and telemetry from automations with events, exceptions and

alerts.
• Unauthorized users cannot pause, resume or stop any of the ongoing automations on any Bot Runner.
• All historical automation data is logged in and available through Control Room Audit Logs.

Informazioni correlate
Control Room overview

Distributed architecture
Automation Anywhere platform is deployed using a distributed architecture.
Centralized management is accomplished via a web-based server, called the Control Room, to manage
all development and execution of the digital workforce. La Control Room è connessa ai Bot Creators e ai
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Bot Runners. I Bot Creators sono sistemi di sviluppo utilizzati per la creazione e la personalizzazione delle
automazioni. I Bot Runners eseguono le automazioni e sono sistemi runtime installati sui computer. I Bot
Runners possono essere distribuiti su desktop, su macchine virtuali in data center o nel cloud.

Distributed architecture with HA/DR support
The Automation 360 self-contained platform within the customer environment mitigates the risk of "cross-
contamination" from an unlikely event of a security breach from another network.
Automation Anywhere supports distributed architecture to deliver the optimal performance and security.
Following are the main distributable components of Control Room which can be clustered to achieve
High Availability (HA). In the image below, Automation Anywhere components are shown in orange and
components provided by your organization are shown in blue. I componenti ospitati centralmente su cloud
e gestiti da Automation Anywhere come il server delle licenze sono mostrati in bianco.

Figura 1: Distributed Mode
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Distributed Cache

Control Room architecture uses distributed cache to update all other nodes as soon as any information is
updated in one of the nodes. This ensures fastest data synchronization across all the nodes and delivers
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seamless user experience. Automation 360 platform uses clustering mechanism to implement distributed
cache, to synchronize all data operations. For example, when the Credential Vault is opened from one
node, it is automatically opened for all other nodes too.
For information on HA/DR architecture for Automation 360 Cloud, see Automation 360 Cloud Security and
Data Privacy.
Concetti correlati
Modelli di distribuzione HA e DR alla pagina 885
Automation 360 provides several deployment options to meet various levels of enterprise cost/price
performance and resiliency requirements. The options include installation on single nodes and on multiple
nodes. Multi-node deployments can be configured for highly available (HA) clusters and disaster recovery
(DR) sites.

Security architecture
Molte delle principali organizzazioni finanziarie del mondo si affidano alla piattaforma per forza lavoro
digitale sicura di Automation 360 per automatizzare le operazioni sensibili dal punto di vista della sicurezza.
The platform's security architecture is founded on Least Privilege principles and a strict Separation of Duty
model with 41 technical controls implemented across seven NIST 800-53r4 Control Families. I controlli
vengono applicati su tre componenti: Control Room, Bot Creators (sistemi di sviluppo) e Bot Runners (fasi
di esecuzione dei bot) attraverso il ciclo di vita dei bot, dalla loro creazione alla rimozione. This security
architecture and the underlying controls are mapped to industry best practices as defined by NIST and can
be readily mapped to other frameworks, for example, CoBIT (SOX) and ISO 27002.

Access controls

Automation 360 limita e controlla l'accesso di bot e utenti alle risorse logiche tra i vari componenti.
• Two independent control planes enforce least privilege. Only developers are enabled to read or write,

only authorized Control Room users to execute automations, (Control Room authorizes and executes)
subject to fine-grained Role Based Access Controls (RBAC) down to individual automations (bot), Bot
Runners and domains.

• Viene applicata la separazione delle funzioni a livello di bot. Ogni bot è offuscato ed eseguito dai Bot
Runners autorizzati corrispondenti.

• Bot execution is controlled via RBAC. Domain privileges are defined across groups of bot and Bot
Runners.

• Sicurezza a riposo e in transito: Tutte le credenziali di accesso sono protette a riposo tramite un
Credential Vault centrale con supporto per archivi di credenziali di terze parti. All communications are
secured in-transit via SSL and TLS.

Configuration management

Configuration management is controlled at both bots and Bot Runner levels.
• The Control Room authorizes, enforces, and logs changes to all Bot Creators and Bot Runners.
• Bots are controlled via a robust version control system, for rollback and full event logging.
• Bot change control on execution is enforced through encryption and authentication.
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Identification and authentication

Identification and authentication is controlled through Microsoft Windows authentication services.
• I Bot Creators utilizzano Active Directory per l'autenticazione
• I Bot Runners hanno due livelli di autenticazione: uno per l'autenticazione di accesso automatico

dell'esecutore e l'altro per l'esecuzione dei bots.
• Credentials are secured at-rest and in-motion through the Credential Vault or integration with third-

party products.

Risk assessment

Risk assessment is undertaken on Static, Dynamic, and Network-based Vulnerability Assessments. Audit
e contabilità vengono stabiliti attraverso l'acquisizione, la registrazione e l'audit degli eventi su tutti e tre i
componenti con acquisizione granulare degli eventi a livello di bot e non ripudio. L'analisi integrata di Bot
Insight fornisce una risposta agli incidenti quasi in tempo reale e l'integrazione con i sistemi di gestione di
informazioni ed eventi di sicurezza.
Informazioni correlate
RPA Security

Security architecture model
Automation Anywhere Cognitive security architecture is founded on Least Privilege principles and a strict
Separation of Duty model with 41 technical controls implemented across seven NIST Control families.
The NIST framework was selected as a foundation for best practices as a way to enumerate the controls
implemented throughout. Translations from NIST to other control frameworks are widely available,
resources are provided at the end of this topic.
The product security architecture is maintained by the Automation Anywhere Product Management team
and forms part of a formal policy model as an integral part of the Automation Anywhere Development
Roadmap. The following table lists the Control families and the corresponding features and security
impacts. Details on each Control family and how the security architecture is implemented in Automation
Anywhere products are in the corresponding topics.

Control Family Control Code Control Room Feature Security Impact

Access controls AC-3, 6, 7, 9, 10, 12 Central policy control Enforce access
restrictions for change
control and least
privileges on system
components:
• Fine grained

access to bots and
Bot Runners is
controlled via RBAC,

• Bot and Bot Runner
domains can be
assigned to roles via
RBAC

• RBAC roles are fully
audited
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Control Family Control Code Control Room Feature Security Impact

AC-2, 3, 5, 6 Role-based access
control (RBAC)

Enable user access,
restricts operational
privileges, enforces
least privilege principles

AC-17 Bot repository Bot versioning system
with access restrictions

AC-3, 7, 9, 10, 11 Bot and Bot Runner
encryption

Encryption and
obfuscation of sensitive
information at bot level
through credential
vault and integration
with key management
systems

Configuration (change)
management

CM-2, 5, 6, 7, 9 Centralized Bot Runner
control

Restrict functionality
based on roles,
domains, implement
deny-all and allow-by
exception

CM-10 Gestione centralizzata
delle licenze

Centralized
provisioning, tracking
and enforcement of Bot
Creator and Bot Runner
licensing

CM-2, 5, 6, 8 Bot operations room

CM-8 Inventory control Maintains centralized
inventory control of all
bots and runtimes

Bot Creator
configuration
management

SA-10 Bot Creator
management, bot
check-in, check-out

Control Room applies
software life cycle
management to bots
from development,
test, and production.
Bot versioning enables
change control of
automations.

Audit and accountability AU-1 through 15 Audit trail Automated event logs
captured on three
levels: Control Room,
Bot Runners, and
Bot Creators. Non-
repudiation is assured
through read-only logs,
all user identities are
bound to actions.
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Control Family Control Code Control Room Feature Security Impact

Identification and
authentication

IA-1 through 5 Active Directory
integration, Bot Runner
ID and Attestation

Implements Windows
platform security
including cryptographic
bidirectional
authentication, Bot
Runner identification
and attestation, and
password management
policies. Credential
vault with integration
with key management
systems, protects the
integrity of credentials.

Incident response IR-4, 6 Incident response Bot Insight embedded
analytics capabilities
can monitor events and
generate alerts to SIEM
systems for response.

Controlled maintenance MA-2 Automated
maintenance

Control Room
versioning system
provides an automated
mechanism to roll
out updates to bots,
historical information is
maintained.

(1) Resources: ISACA provides guides that map NIST SP800-53 to other security frameworks such as CoBIT (SOX),
SANS Top20.

Responsabilità operative Cloud
Informazioni sui modelli di distribuzione sicura, sulle posizioni degli elementi di dati e sulle responsabilità
operative.

Protezione del Cloud

Automation Anywhere Cloud viene distribuito per consentire solo l'accesso al personale operativo e alle
risorse del team di sicurezza Automation Anywhere Cloud. L'accesso al piano di controllo di rete e cloud
è limitato utilizzando VPN con autenticazione a più fattori per il personale operativo e di sicurezza AAI.
Tutti gli utenti AAI devono prima autenticarsi utilizzando token MFA per recuperare le credenziali a breve
termine per accedere alle risorse cloud. Le credenziali utente vengono continuamente monitorate per
la conformità. Tutti gli altri utenti operativi, le risorse cloud e le applicazioni non possono accedere alla
Control Room. Viene condotta una regolare certificazione di accesso degli utenti AAI per garantire che
venga fornito solo l'accesso necessario al personale operativo del cloud.
Il servizio cloud è multi-tenant e ogni ambiente della control room del cliente utilizza un identificativo unico
del tenant per garantire la separazione dei dati tra le Control Room. I membri Automation Anywhere non
possono accedere all'ambiente di un cliente a meno che quest'ultimo non abbia fornito un'autorizzazione
specifica, in genere nell'ambito delle procedure e dei controlli di risoluzione dei problemi di assistenza.

Cloud Con l'offerta Automation AnywhereCloud, tutti i dati
aziendali, personali e operativi vengono memorizzati
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sul cloud amministrato Automation Anywhere.
Automation Anywhere è il controller dei dati sul
cloud ed è responsabile della privacy dei dati dei
clienti, come pubblicato secondo la conformità e
sicurezza del cloud Automation Anywhererispetto
alla privacy dei dati.
Privacy Policy for Automation Anywhere

Abilitato al cloud Con la soluzione abilitata per il cloud Automation
Anywhere, i dati aziendali, personali e operativi
vengono archiviati e gestiti sull'infrastruttura
controllata dal cliente, mentre i dati operativi
specifici relativi alla RPA vengono condivisi tra il
cloud Automation Anywhere e l'infrastruttura del
cliente. Tutta la privacy e la conformità dei dati
spettano al cliente.

On-Premises con aggiornamenti tramite
Cloud

Con Automation Anywhere On-Premises con gli
aggiornamenti tramite il servizio Cloud, tutti i dati
aziendali, personali e operativi vengono conservati
e distribuiti dal server in locale sulla rete del cliente.
Tutta la privacy e la conformità dei dati spettano al
cliente.

La tabella seguente elenca le responsabilità relative alla protezione dei dati e alle operazioni:

Requisito dati Cloud Abilitato al cloud On-Premises con
aggiornamenti
tramite Cloud

Sicurezza delle
infrastrutture e dei dati

Automation
Anywhere Cloud

Cliente condiviso
e Automation

Anywhere Cloud

Cliente

Continuità e ripristino
di emergenza

Automation
Anywhere Cloud

Cliente condiviso
e Automation

Anywhere Cloud

Cliente

Disponibilità elevata Automation
Anywhere Cloud

Cliente condiviso
e Automation

Anywhere Cloud

Cliente

Localizzazione dei dati Automation
Anywhere Cloud

Cliente Cliente

Privacy dei dati Automation
Anywhere Cloud

Cliente Cliente

Aggiornamenti software Automation
Anywhere Cloud

Cliente condiviso
e Automation

Anywhere Cloud

Cliente

La tabella seguente elenca i tipi di dati e le posizioni di storage:
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Tipo di dati Cloud Abilitato al cloud
On-Premises con
aggiornamenti
tramite Cloud

Dati aziendali del
cliente
• Dati personali del

cliente
• Dati aziendali utilizzati

nell'automazione

Cloud. For more
information on Cloud
storage information,

see Automation
360 Cloud FAQ
alla pagina 54.

Rete del cliente Rete del cliente

Dati operativi
• Utenti operativi, ruoli,

password
• Informazioni sul

dispositivo
• Credenziali dispositivo
• Programma Bot
• Definizione Bot
• Log di audit e

applicazioni
• Workload

management
definitions and
schedules

Cloud Rete del cliente

Gestione condivisa:

Cloud
Aggiornamenti

del
pacchetto
di azioni

Cliente
Gestione
di tutti gli
altri dati

Dati personali
• Nome utente e

password
• Chiave di sicurezza
• Informazioni e

credenziali del
dispositivo utente

• Accesso al dispositivo
Bot Runner

• IP/FQDN dispositivo
Bot

• Credenziali
dell'applicazione Bot

• Log dell'applicazione
utente

Cloud Rete del cliente Rete del cliente

Securing the RPA environment with external controls
The Automation Anywhere architecture consists of a standard desktop and server class infrastructure for
the registered devices and the Control Room.
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RPA platform

This topic details the best practices for securing the RPA platform with external security controls. Network-
based firewalls, Intrusion Detection Systems, anti-malware, and external log servers are all standard
security controls that are relevant to RPA deployment and the other infrastructure in your environment.
The following figure shows logically where these components are deployed in the RPA deployment:
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Nell'immagine, i componenti della Control Room sono visualizzati in arancione e i componenti del data
center forniti dalla tua organizzazione sono visualizzati in blu.
Each external security control is discussed in detail in the following sections, in terms of placement and
configuration. Supporting network services such as Active Directory, SMB File Share, Microsoft SQL Server,
and production applications, and are accessed through network firewalls or directly, depending on their
placement relative to the RPA components.

Network-based access control to protect RPA with firewalls

Network-based firewalls and local server-based firewall are used to protect the Control Room or all nodes
in a Control Room cluster. By default, required protocols on the Control Room are permitted from the
corporate network. Additionally, all clustering protocols are permitted only between the nodes in the
Control Room cluster. Network-based firewalls are used to isolate Development, Test, and Production RPA
environments from the corporate network and from each other.
For unattended automation environments, the Bot Runners are placed in a specific isolated network and
protected by a network-based firewall. Attended automations run from corporate workstations with the
Bot Runner Bot Agent installed and are protected via the corporate perimeter firewalls or internal firewalls
protecting the corporate desktop infrastructure, like any desktop.

Anti-malware to protect RPA from viruses and malware

The Automation Anywhere Bot Agent runs on desktop class infrastructure and is considered a corporate
desktop. Anti-malware or anti-virus software is used to protect the registered device environment from
malicious software in the form of viruses and malware.

Intrusion detection systems to protect RPA from direct attacks

Intrusion Detection and Prevention Systems (IPS) protect the corporate network by detecting network-
based attack through network traffic analysis. Like any other critical section of the data center, an IPS
protects the RPA platform at the egress point, behind the network-based firewall.

Independent categories for Bot Creators and Bot Runners
For logical separation of duties, Control Room divides automation users into two broad categories: Bot
Creators (development) users and Bot Runners (run-time) users.
Bot Creators exist on a separate Microsoft Windows system with its own credentialing system to create,
update, and unit test the bots on the Bot Creator. Bot Creators only upload and download bots to and from
the Control Room. Users on the Control Room users have privileges to execute bots on Bot Runners but
have no access to the Bot Creators. This separation of duty constitutes a dual authorization by requiring
both the developer and the business user to create and execute the bot in conformance with NIST AC-3
best practices.

RBAC in Control Room
Control Room implements Least Privileges and Separation of Duties through a configurable Role-Based
Access Control (RBAC) capability that conforms to requirements in NIST AC 2, 3, 5, and 6.
All Control Room users are assigned one or more roles. Access are available based on the usage conditions
assigned to each role when users are a member. Authorized users can temporarily or permanently
suspend other users when needed. RBAC enforces session handling to prevent unauthorized access.
If an unauthorized user attempts to view session details or gain access, the Control Room cluster will
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prevent this progress and immediately terminates the unauthorized session. The unauthorized user will be
prompted to log in with valid credentials. Inactive accounts can be disabled.
The administrator controls are responsible for all security functions, consistent with best practices in NIST
SC-3: Security Function Isolation.
The Control Room includes segmented administrator roles by default. Many permissions are supported for
creating new roles.
Controls are implemented at the Control Room, Bot Creators, and Bot Runners layers, for NIST Access
Controls (AC) and Change Management (CM) guidelines. The following technical controls are implemented
to ensure access is governed through NIST Least Privileges.

RBAC on bots

Access is deny all and allow by exception based on roles, except for admin roles. Addressing NIST AC-17
(access control), NIST configuration managments for NIST CM-2 (base line configurations), access
restrictions for NIST CM-5, NIST CM-6, and NIST CM-7 (least functionality), and monitoring NIST CM-9 for
bot activity across the development, test, and production environment.

RBAC on Bot Runners
RBAC on Bot Runners facilitates complete isolation of one department Bot Runner seamlessly from the
remaining departments' Bot Runners.
Bots are executed from the Control Room cluster. Local bot executions are protected through multiple
layered security, and are designed to prevent fraud as a result from escalation of privileges on Microsoft
Windows. The Bot Runner are executed by Windows, addressing access control enforcement in accordance
with NIST AC-3 Access Enforcement and AC-6 Least Privilege for Code Execution.
If user roles does not have access to sets of Bot Runners, as a result, these users are unable to view the
Bot Runners' executions or remote scheduling automation. See (Role-based processing domains alla pagina
33).

RBAC for Credential Vault credentials management
Credentials created in the Control Room are used across Bot Creators and Bot Runners.
These credentials are securely stored in the centralized Credential Vault to facilitate access control, and to
divide in logical groups called lockers. These lockers enable complete separation between the credentials of
one department from another.

Role-based permissions

Permissions for credential management-related roles include the following:

Manage my credentials and lockers By default, all users can manage their own
credentials and interact with the lockers to which
they have permissions.

Gestisci i miei lockers Allows the user to create and manage their own
lockers.

Administer ALL lockers User can do all the actions in the Admin row of the
Locker permissions table below.

Crea attributi standard per credenziali User can set an attribute value that remains the
same for other users of that credential attribute.
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Locker permissions

Locker permissions are set when a locker is created or edited. A user can have the following permissions in
a locker:

Visualizza
armadietto

Modifica
armadietto

Elimina
armadietto

Add
participant/
owner

Remove
participant/
owner

Visualizza
credenziali

Assign
credential

Remove
credential

User-
provided
value

Standard
value

Consume # #

Participate # #

Gestisci # # # # # # #

Own # # # # # # # # #

Amministratore# # # # # # # # #

Attività correlate
Crea credenziali alla pagina 2842
Create a credential and add the required attributes.
Crea locker alla pagina 2844
Create a locker to group similar credentials to share with other users.
Riferimenti correlati
Credentials and lockers in the Credential Vault alla pagina 2839
L'Credential Vault archivia in modo sicuro informazioni sensibili come password, numeri di account e
numeri di previdenza sociale nelle credenziali e in lockers per l'utilizzo nelle attività di automazione. It
facilitates role-based access for users of a Control Room and ensures that sensitive values are not stored in
bots or on devices.

Role-based processing domains
The Control Room RBAC applies the least privilege principles to domains by implementing Processing
Domains, specifying role-based privileges and permissions at the bots and Bot Runners level.
RBAC is applied at a folder level to completely and seamlessly isolate one department bot from the
remaining department bots. If the user role does not have access to a set of bots, those bots do not exist,
thereby enabling the separation of duties across different domains. For example, finance and accounting
roles can access only the bots that automate their respective functions, and specific Bot Runners can
execute these bots. This is consistent to best practices as defined by NIST AC-4 Processing Domains.
Authorized users assign various roles based on the business need.

RBAC on Audit Log
Audit is automated for all privileged and nonprivileged roles to conform to best practices, as defined in
NIST AC-6.
Access is view-only based on a deny all and allow by exception based on roles and domains as defined in
the Audit section 7 addressing Audit and Accountability (NIST AU 1 through 15) and as required by NIST
AC-2 Automated System Account Management. If a role does not have permission to view Audit Logs,
then the Audit Trail tab is not visible to all members of that role. Audit automatically captures all events
related to creation, modification, enablement, disablement, and removal of users, bots, Bot Creators, and
Bot Runners.
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RBAC on viewing bot activity
The Control Room Activity menu provides options shows the status of the Automation Anywhere
Enterprise automations. These options are: In Progress, Scheduled, and Historical.
Access to bot Activity status is deny all and allow by exception based on roles and domains as defined
in RBAC. Two levels of checks are applied to access the bot Activity data. The user is required to be a
member of a role that has access to view the Control Room. Users with Control Room access that can view
only the bots belonging to their departments, as applied through RBAC on bots.

RBAC on User Management
Access is deny all and allow by exception based on roles, domains as defined in RBAC. Only those users
with access to User Management can manage other users in system.
This permission is further divided into the following sub permissions:

Create Users Only those users that create new users from the
Control Room.

Edit Users Only those users that edit existing users from the
Control Room.

Delete Users Only those users that delete existing users from the
Control Room.

Authorized users assign various combinations of these access permissions to different sets of users and
roles based on the business requirements.

RBAC on roles and permissions management
Access is deny all and allow by exception based on roles, domains as defined in RBAC.
Users with access to roles and permissions management can create, edit, and delete roles in the system.
This permission is typically assigned to administrators and power users from across enterprises.

RBAC on bot schedules
Access is deny all and allow by exception based on roles and domains as defined in RBAC.
This permission is further divided into the following sub permissions:

Programma i miei bots per l'esecuzione Only those users that create new schedules.
Modifica la mia attività pianificata Only those users that edit their schedules.
Elimina la mia attività pianificata Only those users that delete their schedules.
Visualizza e gestisci TUTTA l’attività
pianificata

Only those users that manage (edit or delete) all
the existing schedules created by any user.

Administrators assign various permutation and combinations of these accesses to different sets of users
and roles based on the business requirements.

RBAC on license management
Access to license management is deny all and allow by exception based on roles and domains as defined in
RBAC.
Only those users with access to license management permission are able to update the license from the
Control Room. A common license exists for all the users across Automation 360 for a specific Control
Room. The updated license is effective for all the Bot Creators and Bot Runners registered with the
corresponding Control Room.
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Bot execution access by dynamic access token
The Control Room implements and enforces a Trusted Path for registration and authentication of Bot
Creators and Bot Runners in accordance with NIST SC-11 to protect against any attempt to execute
unauthorized bots.
The Control Room issues new client access tokens or identifiers through hashing, signed by the Control
Room and sent to Bot Creators and Bot Runners over HTTPS. Every subsequent communication between
Control Room and Bot Creator or Bot Runner is serviced by the Control Room after validation of the
signature of the latest access token sent by the Bot Creator or Bot Runner. Each access token is unique to
every Bot Creator or Bot Runner. This ensures that even if an unauthorized user could bypass enterprise
security and access the system, the Control Room security restricts any damage.

Secure credential store through Credential Vault
The Automation Anywhere platform provides a centralized Credential Vault to securely store all credentials
and provision them to bots on an on-demand basis.
Use the Credential Vault to store other information deemed confidential or sensitive. The credential store
implements NIST controls IA-2 to uniquely identify and authenticate organizational users (or processes
acting on behalf of organizational users).
Sensitive information does not have to be stored in bots or on Bot Runner systems, the Credential Vault
facilitates a logical separation of credentials from the bots.
Credential Vault variables (credentials) are created in the Control Room. They are available to the Bot
Creators and Bot Runners who are assigned roles that provide them access to the lockers that contain the
credentials.
The Credential Vault adds flexibility and dynamic character to bots because only the credential references
are present in the bots, and not the credentials. When bots are moved from one environment to another
environment, absolutely no change is required in the bots. Bots can seamlessly pick up the credentials
values applicable for the new environment from the Credential Vault of that environment. Additionally, the
Control Room automatically stores configuration-related sensitive data into the Credential Vault by default.

Credential Vault encryption
The Automation 360 platform offers the embedded Credential Vault and provides an extensive set of
safeguards to protect data at rest and in transit, but also while it is in use on individual systems.

Encryption keys and vault

During the Automation 360 installation process, the system generates an RSA 2048 bit public/private key
pair and an AES 256 bit key. The private key of the RSA 2048 pair is referred to as the Master Key, while
the AES 256 key is referred to as the Data Key. The Master Key is presented to the installing administrator
for safekeeping in a physically secure location off system. The public key is used to encrypt the Data Key.
Both the public key and the encrypted Data Key are then stored in the database. When in use, all keys and
encrypted data are placed in encrypted secure memory using the Microsoft Data Protection API (DPAPI).
During Automation Anywhere Control Room startup or reboot, the administrator is prompted to supply the
Master Key. The encrypted Data Key is retrieved from the database and decrypted using the Master Key.
The Data Key is now ready for use. As the system stores and retrieves data from the Credential Vault, the
Data Key is used to encrypt and decrypt that data.
vault is used to store all system managed credentials and critical system configuration data. It can also be
used to store any other sensitive data used in an organization's automations. As a result, bot builders can
avoid the insecure practice of hard-coding credentials and other sensitive data/ arguments directly within
their automations.
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Multi-layer authentication and fine-grained access control are essential for a tightly controlled environment.
So is end-to-end data protection, which is also necessary to maintain the confidentiality and integrity of
business-critical processes, sensitive data, and related credentials.

Chiave master This RSA-2048 bit key is managed by an
administrator outside of the system. This key
unlocks the Credential Vault. The administrator
types the Master key each time the Control Room
is started. When the vault is open, the master
key is immediately erased from memory and it is
not stored anywhere in the Automation Anywhere
product.

Data encryption key This AES-256 bit key is stored in the Control Room
database and is used to encrypt and decrypt the
credentials at the time of storage or provisioning.
This key is encrypted using the Master key. The
Data encryption key does not leave the Credential
Vault at any time. Credential encryption and
decryption are done at the Credential Vault.

Protection of data at rest

In addition to encrypting local credentials and selecting runtime data used by bots, the Credential Vault
provides secure storage for sensitive configuration parameters and details pertaining to the integral version
control and email services.

Credential storage
All sensitive data is stored in the Credential Vault using AES-256 encryption.
These credentials are encrypted by the Credential Vault service to conform to NIST SC-28 and to prevent
unauthorized access or disclosure of credentials. Only encrypted credentials travel from the Control Room
to the Database server and are stored in the database in an encrypted form. The data encryption key
encrypts all credentials using an AES 256-bit key generated by a FIPS 140-2 Level 1 validated module to
meet the NIST IA-7, SC-12, and 13 requirements for implementation of mechanisms for authentication to a
cryptographic module that meets the requirements of applicable federal laws.
The data for Active Directory user credentials for autologin to Bot Runners is also encrypted and securely
stored in the Credential Vault with the bot credentials.

Credential provisioning to bots
Credentials are provisioned only during the execution of automation.
Bot Runners or bots do not store credentials locally. Credentials are provisioned only during the execution
of the automation. When the credentials are requested by Bot Runners, encoded (64 bit) credentials travel
from the Control Room to Bot Runner over HTTPS protocol. When the bots finish execution, credentials are
erased from the memory.

Cryptographic providers
Use only the listed supported cryptographic providers.
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Control Room

Cryptographic Provider Supported Version

AES-256

AES/CBC/PKCS5Padding

ECDHAES/GCM/NoPadding

HMAC-SHA256

PBKDF2 with HMAC-SHA512

RSA-2048

RSA/ECB/OAEP with SHA-256 and MGF1
Padding

All Bouncy Castle FIPS versions mentioned in the
Automation Anywhere Open Source Software
(OSS) Notice

See: Compliance and vulnerability scanning .

Registrazione sicura
È possibile abilitare o disabilitare l'acquisizione di immagini delle applicazioni aziendali impostando la
registrazione sicura nella Control Room.

Panoramica

Quando la registrazione sicura è abilitata, nessun Bot Creators o Bot Runners può acquisire immagini,
valori o testi dell'applicazione. Di conseguenza, nessun dato sensibile viene salvato, intenzionalmente
o meno, nei bots sotto forma di immagini. I dati di automazione rimanenti, ad esempio i dettagli di un
oggetto dell'interfaccia utente, continuano a essere acquisiti e l'automazione funziona senza problemi.
In qualità di amministratore, puoi applicare questa impostazione dalla Control Room per tutti i Bot Creators
e Bot Runners (per tutti gli utenti o per ruoli specifici).

Impostazione della registrazione sicura

1. Accedi alla Control Room come amministratore.
2. Vai su Amministrazione > Impostazioni > Bot.
3. Nella sezione Registrazione sicura, fai clic su Modifica per configurare le impostazioni.
4. Seleziona Abilita.

Il valore predefinito è Disabilita.
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5. In the Recorder preview image tab, select one of the following options:
• Enabled: A preview of the image is shown in the Bot editor when the object is captured but

discarded after you refresh the Bot editor. The image is stored in the Control Room and deleted
after 60 minutes.

• Disabled: Image is not captured and not stored in the Control Room.

6. Scegli le impostazioni in base alle tue esigenze:

Opzione Azione

Tutti gli utenti Seleziona questa opzione per abilitare la registrazione
sicura per tutti gli utenti che hanno accesso al prodotto.

Utenti con i ruoli selezionati Per abilitare la registrazione sicura per gli utenti con
ruoli specifici:
a. Dalla colonna Ruoli disponibili, cerca e seleziona

i ruoli per i quali desideri abilitare la registrazione
sicura.

b. Sposta questi ruoli nella colonna Selezionati.

7. Salva le modifiche.

Authentication with Control Room
When a Bot Creator or Bot Runner tries to connect to Control Room, the credentials are encrypted using
AES (256 bits key length) and RSA (2048 bits key length) and then transmitted on top of the existing layer
of Transport Layer Security (TLS).
This extra layer of message level encryption provides protection against network stack issues (such as
Heartbleed where OpenSSL was leaking sensitive data from memory) and also adds protection to the
last hop of the connection when TLS is terminated at the load balancer. These credentials are decrypted
by Control Room and authenticated against the hashed (PBKDF2 and HMAC SHA512 algorithm) user
passwords or against Active Directory via Lightweight Directory Access Protocol (LDAP).
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Supported authentication methods for Automation 360 On-Premises
Review the authentication methods supported by Automation 360 On-Premises.

Supported authentication methods

• Active Directory using LDAP
• Active Directory using Kerberos
• SAML
• Local authentication using a database

The benefits of integrating with Active Directory include the following:

Easier adoption Integrates with an existing authentication solution,
compliant with the standards.

Maintenance All passwords and password policies are centrally
administered.

Better user experience Fewer passwords to remember.

Kerberos provides additional benefits over NTLM pass-through authentication.
• Open standard versus closed proprietary standard
• Mutual authentication of client and server
• Integration with smart cards for 2FA

Local authentication manages user passwords through the Credential Vault. Passwords are hashed using
the HMACSHA512 algorithm, which is keyed by the output of the Password-Based Key Derivation Function
(PBKDF2). User passwords are encrypted in transit through TLS 1.2.
All authentication and session management is handled through the well-tested Spring Security framework.
Kerberos integration is provided through the well-tested Waffle framework. SAML integration is provided
through the well-tested OneLogin framework.

Active Directory integration for authentication

Automation Anywhere offers seamless integration with Microsoft Windows Active Directory for access
to the Control Room, Bot Creators, and Bot Runners. When Control Room is integrated with the Active
Directory, all the Active Directory users with basic details are directly available in the Control Room without
any extra configuration. For Active Directory integration, user passwords stay in only Active Directory and
are not saved in the platform.
In addition to Active Directory authentication, the Control Room has its own controls to prevent
unauthorized access to anDynamic access token authentication of Bot Runners alla pagina 42y automation
data.
Dynamic access token authentication of Bot Runners alla pagina 42
Bot Runner users can also configure their Active Directory credentials for Bot Runners machine autologin.
These credentials are saved in the centralized Credential Vault.
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Multi-domain Active Directory support

Automation Anywhere platform architecture supports multi-forest multi-domain Active Directory
integration. Multi-forest multi-domain integration requires trust relationships between the forests and the
domains. Refer to Configure Control Room for Active Directory: auto mode for details. Automation 360 On-
Premises can be configured with Active Directory global catalog server in a way that the Control Room, Bot
Creators and Bot Runners can all be in the same or different Active Directory forests and domains. This
gives the added flexibility and control for large-scale complex deployment where users are spread across
geographies.
Multi-domain support is provided out of the box and no additional configuration is required. The
Automation 360 On-Premises user provisioning from different Active Directory domains is also seamless.
It enables the Automation 360 On-Premises admin to centrally orchestrate the digital workforce running
across the globe.

Support for secure protocols
The Automation Anywhere platform supports secure protocols (TLS 1.2 and TLS 1.3).
• Deployment of bots from the Control Room to remote Bot Runners is done over secure communication.
• Upload and download of bots from the Bot Creator to the Control Room is done over HTTPS.
• Transfer of any information from the Control Room to the database and vice versa is done over secure

communication.
• Transfer of encoded credentials from the Control Room to Bot Runners is done over HTTPS.
• WebSocket communication with the real-time data service in the Control Room is done over HTTPS.

Network security overview
All communication between the Control Room, Bot Creators and Bot Runners is done using outbound WCF
TLS 1.2 communications and inbound HTTPS TLS 1.2.
Bot deployment to remote bot runners, provisioning of credentials, automation scheduling, and event
capture are done exclusively through the Control Room. Use only HTTPS in the production environment.
• The REST APIs use Distributed Cache Service to get shared cached data required for specific

functionality.
• The Scheduler Service makes REST API calls to run a task on a specific client machine at a specific

time.
• Real-time Data Service makes REST API calls to authenticate incoming connection requests. It receives

task execution progress updates by Bot Runners and sends that information to all connected browser
clients using WebSocket Secure (WSS) protocol.

• The Control Room makes REST calls for user authentication and repository operations, for example,
upload a task, download a task, or compare two tasks.

• The Control Room makes REST calls to the validate user session at regular intervals. The Control Room
deploys and runs a task on a specific device using Bot Agent. It uses a TCP/IP channel.

• The Scheduler Service makes REST calls for autologin credentials. It also communicates to the Control
Room to get a license and user session-related information.

• The Control Room makes REST calls to get autologin credentials for a logged-in device. It also
communicates to the Control Room to get the license and user session-related information.

Change management
Access restrictions for configuration management.
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Baseline inventory controls for Bot Creators, Bot Runners and bots

The Control Room provides a single-pane-of-glass on all automation operations and infrastructure,
providing a way to baseline the configuration of the environment. Inventory controls are maintained
through the application of RBAC and the use of the Bot Repository, Operations Room, and License
Management to establish a single point of control for Base Line Configurations (NIST CM 2) access
restrictions for configuration management (NI5T CM 5 and 6). Configure automated baseline reporting
using the auditing and reporting systems in the Control Room.

Change control and documentation RBAC

The Control Room RBAC provides a point of access control and management for all changes to the Control
Room, Credential Vault, Bot Creators, bots, and Bot Runners with an automated mechanism to prohibit
changes and report on any attempts to make unauthorized changes. The logging and auditing system on
the Control Room provides the reporting mechanism for change management to conform to best practices
as described in NIST CM-3 through 5.

Software usage and license management

The Control Room provides an automated mechanism for tracking and controlling the use of licensed
software across Bot Creators and Bot Runners, addressing NIST Change Management CM 10.

Dual authorization change management

Separation of duties is implemented at multiple levels. Dual authorization is achieved through separation of
control planes for the Bot Creators and Bot Runners. Only bots created by an authorized Bot Creator can
be executed by a separately authorized Bot Runner and only by a user who has been given the privileges
to do so by an administrator.

Identity and authentication
All automation actions, for example, create, view, update, deploy, and delete, across Automation 360 are
done only after Control Room authentication is successfully completed.
After authentication is successful, the platform applies a second mandatory level of access control
enforcement in the form of fine-grained Role-Based Access Control (RBAC).
The Control Room has its own controls to prevent unauthorized access to any automation data.

Password hashing
Password hashing does a one-way, permanent transformation of the passwords of the Control Room users,
inline with standard password management practices.
Control Room passwords are concatenated with a salt and then hashed using the
PBKDF2WithHmacSHA512 algorithm before being stored in the database.
• The salt is 256 bits in size and is randomly generated by a cryptographically secure PRNG.
• The HMAC SHA512 algorithm is used for hashing and provides additional security over traditional

approaches.
• A keyed hash provides protection against hash length extension attacks.
• SHA 512 bit key is larger than the commonly used SHA 256 bit key.
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• The key used for the HMAC is from the secure Password-Based Key Derivation Function (PBKDF2).
• Hashing is done for 100,000 rounds (based on NIST recommendations).

Every time a Bot Creator or Bot Runner authenticates against Control Room, its credentials are
authenticated against the hashed credentials.

Authentication failure messages
If an authentication attempt fails, the Automation 360 platform does not specifically state if the username
or password is incorrect. It only states that the supplied credentials are incorrect.
This is one critical information security requirement for Automation Anywhere customers and defends the
system against a brute force attack.
This authentication involves the following:
• Bot Creator, Bot Runner connection to Control Room
• User log in to the Control Room from the browser
• Connection from the Control Room to the SQL Server

All failed authentication attempts are logged. Consulta Log di audit alla pagina 2654. Audit Log access is
provided as per RBAC and audit logs are made available on a read-only basis for all users.

Authentication for Bot Runners
Two layers of authentication are present for deploying the bots on remote Bot Runners.
The Bot Runner is logged on/connected/unlocked using the configured credentials. These credentials are
fetched from the centralized Credential Vault over HTTPS. This first level of authentication is done against
the Active Directory domain automatically, on behalf of the user and is called Bot Runner autologin.
After being authenticated, Bot Runners can be authorized to execute bots independently and
asynchronously.
The following table shows what happens to the user session on the Bot Runner after bot deployment.

User session status
before bot deployment

During deployment User session after bot
execution finishes

No session exists Create a new session and deploy the
bot

Scollegati

Sbloccato Deploy the bot Session remains unlocked

Bloccato Unlock the session and deploy the bot Session is relocked

Disconnesso Unlock the session and deploy the bot Scollegati

Dynamic access token authentication of Bot Runners
The Control Room implements and enforces a Trusted Path for registration and authentication of Bot
Creators and Bot Runners in accordance with NIST SC-11.
The Automation 360 platform protects the automation data against any attempt to subvert the path. The
Control Room issues new client access tokens, or identifiers, after a predefined time period. These tokens
are protected to conform to NIST IA-5 by being signed by theControl Room and sent to Bot Creators
and Bot Runners over HTTPS. Every subsequent communication between the Control Room and Bot
Creator/Bot Runner is serviced by the Control Room only after validation of the signature of the latest
access token sent by the Bot Creator/Runner.
The access token is unique to every Bot Creator/Bot Runner. This protects the system from an
unauthorized attempt to bypass security and execute an unauthorized bot, and is consistent with the best
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practices to conform to NIST IA-9 Service Identification and Authorization. These controls implement IA-3
for cryptographically based bidirectional authentication and attestation of Bot Runners and Bot Creators
before establishing connections. This also addresses requirements around unique, automated, identifier
management IA-4 for multiple forms of authorization and identification. Identifiers are dynamically
managed for audit and control purposes. Identifiers are used as authenticators and managed for
verification on initial deployment, revoke, and prevent reuse. There are no static, unencrypted, identifiers
in use by Bot Creators or Bot Runners and cached tokens are cleared periodically.

Defenses against common vulnerabilities
The Automation 360 platform provides some defenses against common attacks on applications.
The list below contains several examples of these attacks and the security controls in place to prevent
them.

SQL Injection (SQLi)

SQL injection is a high-risk vulnerability that can seriously impact the confidentiality, integrity, and
availability of a database. It enables an attacker to execute any SQL of his or her choosing inside the DB,
thus allowing them to read sensitive data, modify/insert data, and execute various operations.
The Control Room prevents SQL injection using query provided by the Hibernate framework.
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Cross Site Scripting (XSS)

Cross-site scripting is a high-risk vulnerability that can seriously impact the confidentiality, integrity, and
availability of any user web session. It enables an attacker to execute any JavaScript inside the victim's
browser, allowing them to spy on the user's input/output or take unauthorized actions on behalf of the
user. They could also redirect the user offsite to a malicious malware download or a credential phishing
page.
The Control Room prevents cross-site scripting using automatic output encoding provided by the ReactJS
framework.

OWASP Top 10

Automation Anywhere provides the following controls to protect against the OWASP Top 10:

Risk Control

A1: Injection All input is escaped before commands or queries
are executed.

A2: Broken authentication and session
management

See the identification and authentication section.

A3: Cross-site scripting All output is encoded before being returned.

A4: Insecure direct object references Centralized authorization via Spring Security.

A5: Security misconfiguration No default passwords, stack traces hidden,
secure server configuration

A6: Sensitive data exposure See the Security at rest and Security in motion
sections

A7: Missing function level access control Centralized authorization via Spring Security

A8: Cross-site request forgery Using authorization HTTP header

A9: Using components with known vulnerabilities Black Duck software composition analysis tool

A10: Unvalidated redirects and forwards N/A - No redirect functionality present

Compliance and vulnerability scanning
Review details about Automation Anywhere compliance and vulnerability scanning.

Secure software development life cycle (S-SDLC)

Automation Anywhere has implemented a development security plan and protocol that defines a specific
depth of testing and evaluation to be done by the Engineering team on each release, conforming with
best practices as defined by NIST SA-11 Developer Security Testing and Evaluation and NIST SA-15,
Development Process, Standards, and Tools. This plan has been documented and shared with the
Automation Anywhere Engineering teams.
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Veracode vulnerability scanning for static and dynamic code analysis

In each weekly build, during the development process and before every release, all Automation Anywhere
software is scanned for flaws using the Veracode tool. Automation Anywhere Enterprise meets the
requirements for the strictest security policy available in the tool, Veracode Level 5, which is defined as no
Very High, High, or Medium severity vulnerabilities. Analysis reports are available with each release.

Dependency analysis

In each weekly build, during the development process and before every release, all of the third-party
libraries and dependencies in Automation Anywhere software are scanned for known vulnerabilities using
the Black Duck tool. Automation Anywhere upgrades vulnerable libraries when new versions become
available. Analysis reports are available with each release.
All Critical/High vulnerabilities are fixed for each release. Medium vulnerabilities will be considered for fixes
in future releases depending on the scope of the Automation Anywhere releases. The list of OSS used by
the application is published for each release.

Penetration testing

Automation Anywhere does a penetration test through a third-party vendor before each major release.
Additionally, Automation Anywhere incorporates the feedback from penetration tests conducted by
customers, which includes some of the largest financial institutions in the world. Analysis reports are
available with each release.

Additional security controls
Automation Anywhere Control Room restricts the database connection configuration with the system
administrator account.

Restrict installation from database system administrator account

All the database level transactions are done with a nonsystem administrator account. The Control Room
installer passes the SQL Server 2012 certification test.

Autolock the device

When Automation Anywhere bots are deployed from the Control Room to remote Bot Runners, they revert
the Bot Runner system to its original state. For example, if the Bot Runner machine was logged off and our
bot logged into the machine, it logs it off after the automation execution finishes. This ensures that system
level security is not compromised.

Using SHgetKnownFolderPath function

Automation Anywhere software uses the SHGetKnownFolderPath function and Knownfolder_ID to
determine the full path to the special folders. This is a recommended practice from Microsoft and use of
this function ensures that system will never redirect automation data to any other folder, even if someone
attempts to hack the function call. This is also one of the InfoSec requirements of Automation Anywhere
customers.
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API level security

Automation Anywhere software does authentication and authorization level checks at the API level. API
calls are serviced only for those users who have permission on the automation data. Unauthorized users
cannot bypass system security through rogue API calls.

Clean uninstall

When Automation Anywhere Enterprise Client software is uninstalled, it leaves no trailing files or folders
behind. This clean uninstall of the Enterprise Client software complies with InfoSec policies.

Store data in Program Data folder

Automation Anywhere software allows storing of automation data in the Program Data folder, for the files
which must be edited by end users. Permissions are also set on the directory during the installation so that
the user can edit the content of the folder. This complies with the InfoSec requirements of Automation
Anywhere customers.

Protected handling of MSVC DLL files

Automation Anywhere Enterprise Client software uses MSVCxxx.dll files for automation purposes, but it
does not install these files by itself. Client software directly uses the DLL files installed by only the Microsoft
operating system. This ensures that client software does not overwrite the DLL files installed by Microsoft
and our customers do not have to worry about doing one more cycle of checking for any introduced
vulnerabilities.

Assembly manifest

All the executables (.exe file) of the Automation Anywhere Control Room and Enterprise Client software
contain the manifest files which describe assembly metadata, for example, filename, version number, and
culture. This makes our platform comply with organizational InfoSec policies.

Application path on network

Automation Anywhere supports configuration of reading and writing automation data to a location on a
network drive. This enables users to keep all automation data at one place.

Autologin without disabling legal disclaimer

When Automation Anywhere bots are deployed from the Control Room to remote Bot Runners, our
customers do not need to change security settings, for example, disable login page, disable legal
disclaimer, or disable screensaver. Automation deployment works seamlessly without disabling these
settings.
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Secure Java automation

The Automation Anywhere platform can securely automate even those difficult-to-automate business
applications which download the Java runtime environment (jre) during automation execution. Whenever
these applications are started, an Automation Anywhere agent gets associated with Java executable
noninvasive and automates the business application. After the automation finishes, the Automation
Anywhere agent is automatically terminated.

Automation in nonEnglish languages

Users can securely use German, French, Italian, and Spanish language keyboard characters through the
embedded automation commands in Bot Creators. This enables users to write data into these languages.
Automation Anywhere customers do not need to depend on less secure third-party libraries for this
automation.

General Data Protection Regulation guidelines
The General Data Protection Regulation (GDPR) is one of the strictest compliance frameworks for
maintaining privacy of personal data. The GDPR defines personal data as any data that can be used to
identify a natural person (Data Subject).
For the most current description of Automation Anywhere GDPR compliance statement, see Cloud
Automation Agreement and Privacy Policy for Automation Anywhere.

Automation 360 architecture and resiliency
Automation 360 is a single, integrated platform that transcends front office and back office technology silos
to automate business processes across all systems and applications, including both SaaS and legacy apps.
The Automation 360 platform is deployed using a distributed architecture.
Centralized management is done through a web-based server, called the Control Room, to manage all
development and execution of the digital workforce. The Bot Agent executes automation and are run time
systems installed on the devices.
The following image shows the architecture and relation between Control Room and Bot Agent:
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• *indicates that the Control Room creates a unique user name and device ID to persist in the public key
in the database.

• **indicates that device public key is validated by the Control Room and a new token is created.

The following table describes the flow and the actions that occur between the Control Room, Bot Agent
and the back end services (as numbered in the previous image):

Azioni Descrizione

1 The browser sends the device token to the Bot Agent for registration.

2 The Bot Agent then registers the device request to create a public
key and a token.

3 The back end services of the Control Room sends a response to the
Bot Agent that the device has been registered with a unique user
name and device ID.

4 The Bot Agent sends a message to the browser that the device has
been registered successfully.

5 The Bot Agent sends a message to the back end services of the
Control Room to indicate that the JSON web token has been
authenticated successfully.

6 The back end services of the Control Room then validates the device
public key and establishes a Web Socket connection with the new
token.
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Control Room and Bot Agent resiliency

The following table provides you the behavior and resiliency differences between Automation 360 and
Enterprise 11.

User
action
Bot Agent in Automation 360 Bot Runner Client in Enterprise

11
Note

ServiziInstallation services are run on
the local device.

Installation services are run
inside an active user session.

RegistrationDevice is registered to the
Control Room.

An active user is registered to
the Control Room.

Bot Agent service runs on the
local system.

AutenticazioneControl Room stores the agent
public key in the database.

Control Room stores the
authentication key in the
memory.

In Automation 360, the Control
Room stores the public key
in the database. So when the
Control Room restarts, the
reconnection is accepted faster.
The Bot Agent is resilient across
Control Room restarts.
However, in Enterprise 11, the
Control Room reconnection
does not happen after a restart.

Distribuzione
di
Bot

Priority of bots is verified at
deployment.
Quando i bots sono in coda per
un utente Bot Runner, i bots
con priorità più alta vengono
distribuiti prima dei bots con
priorità più bassa.
However, if a lower-priority
bot is already running, higher-
priority bots are deployed only
after the lower-priority bot
completes running.

Quando un bot a bassa priorità
è in esecuzione e un bot ad
alta priorità viene distribuito, il
sistema mette in pausa il bot a
bassa priorità ed esegue il bot
ad alta priorità.
Dopo che il bot ad alta priorità
viene eseguito, viene ripresa
l'esecuzione del bot a bassa
priorità.

Advantage in Automation 360
is that lower priority bots are
not paused and complete their
deployment before the high-
priority bots are deployed.

Error
Handling
Error handler package contains
actions to easily handle
exceptions a bot encounters
and transfers control to other
actions within that bot.

Error Handling command helps
in debugging when the TaskBot
and MetaBot Logic are run.

DispositiviConnected when device is
registered with the Control
Room.
Reconnects when the device
restarts.

When the Bot Runner Client
restarts or loses connectivity
with the Control Room, you
must re-log to the Client to
reconnect.

Bot Agent reconnects without
individually logging in to every
single device.

ReconnectionBot Agent reconnects
automatically if there is an
interruption.

The Bot Runner client needs to
be reconnected manually.

Bot registration in Automation
360 is more robust and can
reconnect automatically to the
Control Room.
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User
action
Bot Agent in Automation 360 Bot Runner Client in Enterprise

11
Note

Public
and
private
key

Public and private key is
generated at the time of device
registration.
This key is used to authenticate
to the Control Room.

Same behavior as in
Automation 360.

ServiziBot Agent is run as a service.
When device reboots, the
services are automatically
connected to the Control Room.
Bot Agent continues to check
for connection even if the
Control Room is down by using
the public and private key.

Requires a client to log in and
perform tasks.

Remote
connection
Remote Desktop Protocol is
supported only on multi-user
devices.
The Control Room does not
maintain the RDP.

Remote Desktop Protocol is
supported on both single and
multi-user devices.
In Enterprise 11, Remote
Desktop Protocol connection
is established from the Control
Room and maintained by the
Control Room.

Auto-
updates
Control Room administrator can
choose to automatically update
the Bot Agent to a later version
using auto-update capability.

Auto-update option is not
available.

Auto-update reduces downtime
because each user is not
required to log in to the Control
Room to update the Bot Agent
installed on the user device.

Configuration
updates
Updates are pushed through
Cloud

No standalone configuration
updates, but you can change it
manually.
Enhancements to the
configurations are released as
patches.

Global
cache
Configure device settings to
automatically set a user's
current device as default device
after the user logs in to the
Control Room.

Non disponibile
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User
action
Bot Agent in Automation 360 Bot Runner Client in Enterprise

11
Note

Loss
of
connection
from
Bot
Agent
to
Control
Room

Bots that are already running
run to completion during the
update.

In general, bots already running
can run to completion during
the update. Exceptions are as
follows:
• If the bot tags data for Bot

Insight, the bot will not run.
• Parent/child bots will run

to completion because the
child bots are downloaded
at the start of running the
parent bot. However, if child
bots are referenced using a
variable parameter, calling
those child bots need the
Control Room to be available
during parent bot runs.

• Bots that use workload
management (WLM) will not
run.

• If a bot is using values from
Credential Vault, the bot
execution might fail if the
Control Room connection
is interrupted or lost. This
happens as the bot fetches
the value from Credential
Vault at the time of use.

Scheduling resiliency

Device pools provide built-in high availability (HA) for the Bot Runner devices if your unattended license
is free to use. You are not tied to a single Bot Runner device, so if your device is unavailable for any
reason and your unattended license is free for deployment, your automation is not affected. The scheduled
automation will automatically run on the next available Bot Runner device, thereby providing high
availability.
Consulta About device pools alla pagina 2635.

Domande frequenti su Automation 360
Per i dettagli e le domande sulla piattaforma Automation Anywhere più recente, Automation 360, consulta
queste domande frequenti.

Cos'è Automation 360? Automation 360 offre un'esperienza intuitiva basata
su browser consentendo agli utenti aziendali di
automatizzare facilmente le attività e offrendo
inoltre potenti strumenti agli sviluppatori per creare
l'automazione dei processi e garantire la sicurezza,
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la governance e il controllo su un'infrastruttura
scalabile per l'IT.

Cosa include Automation 360? Questa piattaforma ti offre tutto il necessario per
creare i bots di cui hai bisogno per automatizzare
i tuoi processi aziendali: Control Room cluster,
Bot editor, Bot Runner, Automation Anywhere,
certificazioni sulla sicurezza di livello enterprise,
supporto, accesso a Universal Recorder e ai corsi su
Bot Store University.

Come viene distribuito Automation 360? Automation 360 può essere distribuito come On-
Premises e Cloud.
Per la distribuzione di Automation 360 On-Premises,
l'installazione viene effettuata nei server del cliente.
Data la natura basata sul Web di Bot Creator, non
è richiesta alcuna installazione o distribuzione
sulle macchine dell'utente, con una conseguente
riduzione significativa del costo totale di proprietà
(Cost of Ownership, TCO).
Automation 360 distribuito nel Cloud offre una
soluzione chiavi in mano in cui gli acquirenti
non devono preoccuparsi di scegliere il provider
di servizi cloud o qualsiasi altro elemento
dell'infrastruttura, Automation Anywhere si occupa
di tutto. Gli amministratori ottengono il set completo
di funzionalità per la gestione degli utenti, la
sicurezza, la governance e il controllo a cui possono
anche accedere tramite un browser Web. Gli utenti
finali possono quindi accedere alla piattaforma
utilizzando i loro browser, eseguire il login e iniziare
a creare i propri bots.

Quali opzioni aggiuntive di cloud hosting
sono disponibili?

Automation 360 può essere ospitato su AWS,
Microsoft Azure, Google Cloud, IBM e qualsiasi
servizio cloud pubblico, privato o ibrido.

Come viene consegnato Automation 360? Puoi iniziare il tuo viaggio verso l'automazione con
Automation 360 in uno dei seguenti modi:
• Automation 360 (Cloud o On-Premises):

Automation 360 è una piattaforma end-to-end
intelligente nativa per il cloud che può essere
utilizzata per automatizzare i processi aziendali
in tutti i sistemi e le applicazioni.
Per ulteriori informazioni, consulta: Informazioni
su Automation 360 alla pagina 11.

• Community Edition: Community Edition provides
a free web-based option for users to experience
a range of Automation 360 bot creation
capabilities. Community Edition può essere
utilizzata da piccole organizzazioni (meno di 250
macchine).
Community Edition fornisce una licenza Bot
Creator che può essere utilizzata per accedere
a un dispositivo e distribuire un bot alla volta.

© 2023 Automation Anywhere. All rights reserved.     52



    Automation Anywhere - Esplora

Non ci sono limiti al numero di automazioni
che si possono creare, ma avrai accesso solo a
funzionalità limitate.
Per ulteriori informazioni, consulta: Introduzione a
Community Edition alla pagina 1021 | Community
capacity and limitations alla pagina 1022.

• Prova gratuita: la licenza di prova gratuita
fornisce un periodo di valutazione di 30 giorni
che può essere utilizzato per valutare il prodotto
e prendere una decisione informata. La prova
gratuita supporta sia la distribuzione Cloud
che On-Premises e fornisce l'accesso all'intero
set di funzionalità, nonché al supporto tecnico
completo per 30 giorni. Avrai accesso a tre
licenze Bot Creator e due Bot Runner.
Per ulteriori informazioni, consulta: Licenze di
prova alla pagina 994.

Quali sono i linguaggi di scripting supportate
da Automation 360?

Automation 360 supporta JavaScript, Python e
VBScript.

Automation 360 è disponibile in lingue
diverse dall'inglese?

Sì, Automation 360 è disponibile in 10 lingue:
inglese, francese, tedesco, italiano, giapponese,
coreano, portoghese, spagnolo, cinese semplificato
e cinese tradizionale.

Come viene aggiornato Automation 360? Per Automation 360 distribuito come Cloud, i
clienti hanno sempre la versione più recente
con aggiornamenti che vengono implementati
regolarmente da Automation Anywhere.
Per funzionalità come action packages, gli
amministratori e gli utenti hanno la possibilità di
provare gli ultimi packages prima di scegliere di
accettare l'aggiornamento.
Per i clienti di On-Premises, gli aggiornamenti
regolari sono resi disponibili attraverso il portale
clienti, fornendo agli amministratori la possibilità di
mantenere la propria installazione a livello aziendale
con la versione scelta.

Quali sono alcuni degli aspetti relativi alla
privacy e alla sicurezza dei dati di Automation
360?

Le funzionalità di privacy di Automation Anywhere
Cloud comprendono una serie completa di funzioni
di sicurezza che garantiscono automaticamente,
o che possono essere configurate dal proprietario
per garantire, la protezione dei dati. Automation
Anywhere Cloud include una protezione completa e
crittografa i dati sia in transito che quando inattivi.
No personal data goes outside of the environment–
unless you tell it to; it remains completely under the
control of the IT manager.
Per garantire che i clienti possano fidarsi di AAI
Enterprise Cloud, i servizi Automation Anywhere
Cloud sono protetti in base a standard e framework
di settore come NIST Cybersecurity Framework,

© 2023 Automation Anywhere. All rights reserved.     53



    Automation Anywhere - Esplora

AWS Cloud Adaption Framework, baseline Center
for Information Security (CIS) e altri.

Automation Anywhere Cloud è altamente
disponibile?

Automation Anywhere Cloud viene distribuito
utilizzando ambienti Control Room con
bilanciamento del carico di Automation 360
distribuiti su servizi di infrastruttura cloud pubblico
completamente HA (Alta disponibilità) all'interno di
una regione.

Automation Anywhere Cloud è protetto con il
ripristino di emergenza?

I backup vengono trasferiti ogni 6 ore in un'altra
regione (ad eccezione dell'Australia dove vengono
conservati all'interno del Paese). Se viene dichiarata
un'emergenza per la regione primaria, viene creata
un'istanza di una regione secondaria per tutti i
tenant utilizzando il backup. Gli obiettivi attuali per
questo tipo di ripristino sono:
• RTO (Recovery Time Objective, Obiettivo dell’ora

di recupero): l'ora in cui attivare una nuova
regione con gli ultimi dati di backup ripristinati =
6 ore.

• RPO (Recovery Point Objective, Obiettivo del
punto di ripristino): La durata massima per la
perdita di dati durante un ripristino = 6 ore.

Nota:  Una regione del ripristino di emergenza
potrebbe trovarsi in un Paese differente.

Concetti correlati
Note sulla versione Automation 360 alla pagina 63
Esamina le nuove capacità, le modifiche, le correzioni (problemi risolti), le correzioni di sicurezza, le
funzionalità obsolete e le limitazioni di ogni versione.

Automation 360 Cloud FAQ
Answers to frequently asked questions (FAQ) and related information provide insight into various aspects
related to Automation 360 Cloud.

Dove è possibile trovare una panoramica
sulla sicurezza di Automation 360 Cloud?

An overview and details about Automation 360
Cloud security can be found in this document:
Automation 360 Cloud Security and Data Privacy.

As a customer, how can I start using
Automation 360 Cloud?

The prerequisites and additional, optional steps for
getting started can be found on the Automation
Anywhere documentation portal at the following
location: Introduzione a Automation 360 Cloud alla
pagina 827.
Per la maggior parte dei clienti, i requisiti di base
consistono nel consentire un accesso sicuro, tramite
HTTPS, al nuovo ambiente della Control Room
ospitato su Automation 360 Cloud. Se non è già
abilitata, è necessario aprire la porta 443 nel
firewall per consentire la comunicazione HTTPS
verso l'esterno dal browser e dal Bot Agent alla
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Control Room. Dopo l'installazione del Bot Agent,
esso stabilisce una connessione Web socket alla
Control Room. Non è necessario aprire alcuna porta
sul sito del cliente per le connessioni in entrata.

Does Automation 360 Cloud provide a
service-level agreement (SLA) for service
availability?

Yes, an SLA for 99.9 percent monthly availability
is provided for the customer's access to their
production Control Room environment. The
SLA does not include planned downtime for
maintenance and updates to the service. Se un
cliente ritiene che lo SLA non sia stato rispettato,
può richiedere un credito di servizio tramite
l'assistenza. I dettagli sono disponibili in Availability
Service Level Terms.

How does Automation 360 Cloud support
high availability (HA)?

Each customer's Automation 360 environment
is deployed using application load balancing
across highly available public Cloud infrastructure
services. I servizi di infrastruttura supportano sia
i microservizi in esecuzione su container Docker
in cluster Kubernetes sia i datastore (database,
cache, registrazione, file system, archiviazione)
che supportano l'HA su più zone all'interno di una
regione. Both AWS and GCP public clouds are used.

Automation 360 Cloud supporta il ripristino di
emergenza (DR)?

Sì, Automation 360 Cloud supporta il DR. Under a
disaster recovery scenario the customer's tenants
will be brought up in another region using the
same URL and their Bot Agent will reconnect
automatically. In case of major incidents, where
imminent resolution seems unavailable, a disaster
situation is declared and all the tenants within the
region affected by the incident are failed over to
another, remote region. Gli obiettivi attuali per
questo tipo di ripristino sono i seguenti:

RTO (Recovery Time
Objective, Obiettivo
dell'ora di recupero)

The time taken to get
a new region up and
running with the last
backup data restored is
4 hours.

RPO (Recovery
Point Objective,
Obiettivo del punto di
ripristino)

The maximum duration
for data loss during a
restore is 4 hours.

Nota:  L'RPO si basa sui backup eseguiti e inviati a
un'altra regione di backup.

Sono note finestre di manutenzione per
Automation 360 Cloud?

Yes, Automation Anywhere updates Automation
360 Cloud every 3 months so that customers will
receive automatic and regular updates to the latest
software version. Per ulteriori informazioni, consulta
Automation 360 software lifecycle policy alla pagina
742.
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Il canale principale per comunicare le tempistiche
delle finestre di stato e manutenzione del Cloud
è Automation 360 Cloud Service Status site. È
possibile iscriversi a questo sito Web e ricevere
aggiornamenti. Note that you cannot choose when
the updates are rolled out across the multitenant
Cloud. The Automation 360 architecture is designed
to allow these timeless updates to roll out without
affecting customers' bot development lifecycles.

As a customer, what actions should I take
to plan for an Automation 360 maintenance
window?

A customer's bot operations should take account
of scheduling bots to run outside of the published
maintenance windows. These updates are
scheduled to run outside of normal business hours
on the same day and time per region, and focuses
on mid-month, avoiding month ends. More details
guiding customers on planning around maintenance
windows can be found on this KB article: Automation
360 Cloud updates alla pagina 756.

I dati dei clienti vengono memorizzati su
Automation 360 Cloud?

Sì, i processi di automazione di base consentono
ai clienti di mantenere i dati aziendali sulla propria
infrastruttura sfruttando un'accurata progettazione
d bot. Tuttavia, le applicazioni di Automation 360
memorizzano sempre più spesso i dati dei clienti
su Cloud. Diversi prodotti Automation Anywhere
memorizzano i dati del cliente come parte di
automazioni definite dal cliente, anche se in genere
solo temporaneamente, ossia durante il processo di
automazione definito dal cliente.
Ad esempio:
• IQ Bot use typically involves uploading images

for processing.
• Recorder and AISense Recorder store recorded

screenshots.

Nota:  Secure recording can be enabled by
administrators to ensure that these are not
stored.

• L'AARI memorizza i dati elaborati dai moduli
assistiti.

• Bot Insight can be used to create dashboards
made from tagged business data being
processed by a bot.

• WLM stores Work Items in its queues.

Il cliente ha il controllo su quali dati aziendali
vengono memorizzati in Automation 360 Cloud. Si
noti che i dati di origine rimangono di competenza
del cliente e che soltanto quest'ultimo può
cancellare i dati su Automation 360 Cloud. In
general, the business data a customer keeps
in our Cloud through the use of bots is for
automation purposes only and can then be deleted.
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L'archiviazione primaria dei dati non avviene sul
nostro Cloud. Customers might need to keep audit
logs and dashboard data. Entrambi possono essere
esportati.

Che cos'è la policy di conservazione dei dati
di Automation 360 Cloud?

During a customer's subscription period, data on
the Automation 360 Cloud is in their control. Audit
logs have a retention policy maximum of 270 days.
Backups are taken every 4 hours and kept for seven
days. Al termine di un abbonamento, in base alla
policy di conservazione, i dati vengono conservati
per altri 30 giorni per consentire il rinnovo o il
recupero di bots e report, dopodiché vengono
eliminati. Dopo 60 giorni, l'intero ambiente tenant
viene eliminato.

I dati vengono archiviati su Automation
360 Cloud utilizzando un'infrastruttura di
archiviazione comune?

Sì. The data storage services used by Automation
360 Cloud are shared across customers as part of
the multitenant design. In questo modo, i clienti
non risentono dei costi di infrastruttura e operativi.
Automation Anywhere applications use a unique
tenant ID to ensure that data access is logically
segregated by tenant. Nessuna operazione di
elaborazione o archiviazione dei dati può esporre i
dati di un cliente a un altro cliente.

Il personale Automation Anywhere può
accedere ai dati dei clienti memorizzati su
Automation 360 Cloud?

Sì. However, operational controls governed by
Automation Anywhere compliance certifications
ensure that such access is limited to a well-defined
set of individuals in CloudOps, SecOps, and Support
organizations under strict separation of duties.
L'accesso ai dati dei clienti avviene solo quando il
cliente concede l'autorizzazione per risolvere un
caso di assistenza.

A quali normative è conforme Automation
360 Cloud?

CloudOps is governed by the following certifications
based on third-party audits: SOC 1 Type 2, SOC 2
Type 2, ISO 27001, and HITRUST
Il sistema Business Continuity Management
Automation Anywhere è inoltre certificato ISO
22301.
I clienti fanno affidamento sulle certificazioni
standard del settore per motivi normativi e di
conformità. SOC 2 è stato creato dall'American
Institute of CPAs (AICPA) per la misurazione dei
controlli di sicurezza informatica. The SOC 2 Type
2 certification verifies that Automation Anywhere
CloudOps and SecOps teams have taken the
appropriate controls and have put operational
processes in place to meet industry standards for
secure Cloud operations.

Le certificazioni di conformità e i report
riepilogativi delle certificazioni sono
disponibili per i clienti?

Sì, i clienti possono ora accedere ai vari report
riepilogativi e alle certificazioni su Security and
Compliance Portal nella sezione NDA.
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How does Automation 360 Cloud support
GDPR and an individual's privacy?

Automation Anywhere has put processes in place
to handle individuals' data privacy rights, and
reviews them on a regular basis to ensure GDPR
compliance. Per ulteriori informazioni, consultare la
nostra Privacy Policy.

Do Automation Anywhere personnel
monitor an Automation 360 Cloud tenant's
environment?

Sì. Tutti i registri di audit a livello di infrastruttura
e di applicazione vengono monitorati per garantire
il corretto funzionamento dell'ambiente sottoposto
a carico. In questo modo, quando vengono
raggiunte le soglie di carico, è possibile applicare
risorse aggiuntive per garantire la disponibilità e le
prestazioni del servizio.

Does Automation Anywhere report
unsuccessful data breaches to a customer?

No, Automation Anywhere reports only successful
breaches to a customer when that customer's
data has been compromised and on a timeline
determined by local law.

What data does Automation Anywhere
collect to improve the Automation 360 Cloud
service?

To operate and support the service, Automation
Anywhere captures logs that can include usernames
from the system. Essi ruotano e vengono
sovrascritti ogni 30 giorni. Automation Anywhere
collects and uses telemetry data only for purposes
of improving the service. I dati di telemetria raccolti
includono quanto segue:
• Registri di audit: Essi riflettono le attività

dell'utente all'interno di Control Room e
applicazioni, ad esempio quando un bot viene
eseguito correttamente o un utente crea un bot.

Nota:  Il nome utente effettivo è mascherato.
I registri possono includere indirizzi IP, nomi di
dispositivi e nomi di bot.

• Quando l'utente fa clic su una funzionalità UX:
Contribuisce a fornire opzioni di assistenza e
guida specifiche per l'utente nell'interfaccia
utente, in base alla sua esperienza.

• Where documents are uploaded for processing
(for example, when using IQ Bot or AISense),
Automation Anywhere may reconstruct the
format of the document, without the customer's
data, for the purpose of further training
the Automation Anywhere AI/ML models to
recognize document fields that might contain
data for extraction. This aids in improving the
application's data extraction accuracy.

I dati di telemetria possono essere utilizzati per
monitorare il servizio e sono visibili per Control
Room di tenant e in aggregato, in modo da poter
stimare l'utilizzo e l'adozione delle funzionalità. I
dati possono essere utilizzati dal team di gestione
dei prodotti per determinare le funzionalità a cui
dare priorità per il miglioramento e identificare
le funzionalità o le applicazioni che non vengono
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adottate. Questi dati possono anche aiutare i CSM a
consigliare ai clienti le funzionalità inutilizzate da cui
trarre vantaggio.

In which geographical region is a customer's
data stored when using Automation 360
Cloud?

In general, for the pure Cloud deployment model, a
customer specifies the regional location at the time
of provisioning their Control Room instances, for
example, US East or Japan.
Non possiamo fornire l'indirizzo o la posizione
dettagliata del data center fisico poiché ci avvaliamo
di provider Cloud pubblici, che si riservano il diritto
di effettuare il trasferimento senza divulgare le
posizioni per motivi di sicurezza. Forniamo questa
funzionalità a livello regionale per garantire che
la Control Room sia situata nella stessa regione
in cui il cliente eseguirà la maggior parte delle
sue operazioni, al fine di assicurare prestazioni
e usabilità elevate e ridurre la latenza. For most
locations, for business continuity, the disaster
recovery element of the service sends data backups
every six hours to another region. L'altra regione si
trova solitamente in un diverso paese.

Quali posizioni regionali sono supportate da
Automation 360 Cloud?

Gli ambienti della Automation Anywhere Control
Room possono essere ospitati nelle seguenti
regioni:

Principale Backup/DR

Stati Uniti occidentali Stati Uniti orientali

Stati Uniti orientali Stati Uniti occidentali

Europa occidentale Europa centrale

Giappone Singapore

Singapore Giappone

Brasile Stati Uniti orientali

Bahrein Europa occidentale

India Singapore

Australia -

Sudafrica Europa occidentale

Stati Uniti centrali Stati Uniti orientali

Europa occidentale4 Europa centrale

Canada -

Il cliente dovrebbe preoccuparsi per la
sovranità dei dati (ossia per il mantenimento
dei dati in una regione specifica)?

For customers concerned about data sovereignty,
the Pure Cloud model can only guarantee that data
is stored in the US, EU, and in Australia. Ciò non
impedisce l'accesso ai dati al di fuori di tali regioni
(ad esempio, per scopi di assistenza). Per gli Stati
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Uniti, la regione DR è mantenuta all'interno degli
Stati Uniti.

Nota:
1. The DR service is not supported in Canada and

Australia (specifically because most customers
in Canada and Australia are conscious of data
sovereignty).

2. For EU, we cannot guarantee that data is kept
within a specific country within the EU.

Which public Cloud providers are used to
deliver Automation 360 Cloud services?

Automation 360 Cloud uses Amazon Web Services
(AWS) and Google Cloud Platform (GCP) to deliver
Automation 360 Cloud services. Automation
Anywhere decides on the default provider to use.
However, if you have a strong preference for AWS
or GCP, you should work with your account team to
choose the preferred Cloud service at the time of
closing the sales transaction. For existing customers
in the US and EU who provision for a new Control
Room, the new tenants are created in the same
region where your other tenants are located.

Nota:
• IQ Bot classic is not supported on GCP.
• Migration of Enterprise 11 On-Premises Control

Room to Automation 360 Cloud service on
GCP using the Cloud Migration Utility is not
supported.

Che cos'è una Control Room sandbox? A sandbox is a fully functional and supported
Control Room that receives new release updates
at least 3 weeks prior to a customer's main Control
Room for Bot Lifecycle Management (Dev/Test/
Prod). The sandbox environment primarily allows
customers to try out new releases and sanity-test
their production bots.

Nota:  IQ Bot and DR are not supported on
sandbox environments.

La sandbox consiste in un ambiente di prova? No. A differenza di una sandbox, una Control
Room di prova o proof-of-concept viene fornita
gratuitamente per 30 giorni prima di una vendita,
come parte della transazione con i clienti.
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Private Bot Store
Private Bot Store is a secure internal bot marketplace for a company to post and share details and
documentation for all internally developed bots. Employees can easily discover internal bots and
commands to reuse in addition to all of the bots from the Automation Anywhere Bot Store vendors.
Use Private Bot Store to perform the following tasks:
• View, access, and reuse bots to automate processes:

• Find and reuse bots built by your team
• Use filters to search for bots by applications, business processes, or a keyword
• Use bots from the Automation Anywhere Bot Store vendors
• Review detailed documentation provided with each bot to decide whether to use the bot

• Submit details and documentation about your own bots
• Use the Suggested bot idea page to submit a bot idea

Use bots within your company:
• If required, email a bot developer for bot installation assistance
• Review and access bots in your Control Room

Use admin tools to help you with the following tasks:
• Review, approve, and publish bots
• Review your team's bot use case ideas
• Add or remove users and assign permissions

Watch the following video on how to get started with Private Bot Store:

Concetti correlati
Getting started with Private Bot Store alla pagina 2948
Use Private Bot Store to view and submit bots and bot use cases within your company. Use admin tools to
review and publish bots and manage users.
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Learn
Learn about software policies and feature deprecations that impact Automation Anywhere products.

Release notes

Learn about what's new, changed, fixed, or the issues (limitations) in Automation 360 releases:
• Note sulla versione Automation 360 on page 63
• Note sulla versione Community Edition on page 638
• Automation 360 Package SDK Release Notes on page 709
• Process Discovery Release Notes on page 716
• CoE Manager Release Notes on page 718

Comparison matrices

Compare features between products to review feature parity and understand compatibility in order to
update or move to our latest product release.
• Matrice di confronto delle funzionalità per Automation 360 on page 722
• Matrice di confronto delle funzionalità per Automation 360 IQ Bot on page 735
• Compatibilità delle versioni di Automation 360 IQ Bot on page 740

Software lifecycle policy

The Automation Anywhere software lifecycle policy aims to provide predictability, quality, and importantly
nondisruptive access to the latest innovations and enhancements so that you can control when and how
you want to adopt these enhancements.
Consulta Automation 360 software lifecycle policy on page 742.

Cloud Service status

Our Automation 360 Cloud Service Status site shows real-time operational status, historical operational
status, maintenance information, and incident history for all Automation 360 Cloud services worldwide,
across all hosting regions.
Consulta Automation 360 Cloud Service Status site on page 750.

Feature deprecations

Learn about features and capabilities (from Automation Anywhere or third party) that are deprecated or
nearing deprecation to understand how they affect your automation and what action is required.
Consulta Feature deprecations affecting Automation Anywhere products on page 759.
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Note sulla versione Automation 360
Esamina le nuove capacità, le modifiche, le correzioni (problemi risolti), le correzioni di sicurezza, le
funzionalità obsolete e le limitazioni di ogni versione.

Note:  Enterprise A2019 è ora denominato Automation 360. Although the release notes for releases earlier
than Automation 360 v.21 reference the old product name, the content in these release notes is applicable
and relevant to Automation 360.

Utilizza i link per visualizzare gli aggiornamenti delle note sulla versione per ogni versione.
Related concepts
Note sulla versione Community Edition on page 638
Rivedi le nuove capacità nelle diverse versioni di Automation 360 Community Edition.
Related reference
Matrice di confronto delle funzionalità per Automation 360 on page 722
Puoi utilizzare la matrice di confronto delle funzionalità per confrontare le funzionalità di Automation 360
con le funzionalità di Automation Anywhere Enterprise 11.3.x e delle versioni Enterprise 10.
Domande frequenti su Automation 360 on page 51
Per i dettagli e le domande sulla piattaforma Automation Anywhere più recente, Automation 360, consulta
queste domande frequenti.

Note sulla versione Automation 360 v.28
Data di rilascio: 22 marzo 2023

For Sandbox environment only

Important:  These release notes are applicable only to Automation 360 v.28 release for sandbox
environment (Build 17464). The .28 release for On-Premises is not yet generally available (GA), so the
content on these pages is subject to change until the On-Premises GA.

Review the top five features in this release as well as other new features and exciting enhancements for
Automation 360 v.28 release (Build 17464).

Highlights of this release

Here are the top five features in the v.28 release:

Document Automation and Google Document
AI

Validation-based improvement on Google Document
AI extractions: Empower your employees to
save time and automate more documents using
Document Automation and Google Document
AI validation feedback, which in turn provides
improved extraction accuracy for Document AI
learning instances.
Leverage integration update with the latest Google
Document AI parsers: Improve extraction accuracy
and enable 7 additional languages (including Italian
and Portuguese) for Document AI invoices, and
Japanese for Document AI expense receipts.
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CoE Manager: Value tracking for On-Premises
automations

Calculate ROI for automations running on an On-
Premises Control Room by running a bot to push
automation-run data to CoE Manager. View your
ROI data in real-time dashboards and create a
healthy pipeline of automations that will help propel
your business forward.
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Empower business users with Embedded
Automation and Microsoft Teams

Bring automation to your employees in their favorite
collaboration tool Microsoft Teams. Employees can
be in a chat or team channel, or open Embedded
Automation from the Apps menu to view a list of
the AARI processes and desktop automations they
have access to. They can start and monitor these
automations, without having to leave Teams.

© 2023 Automation Anywhere. All rights reserved.     65



    Automation Anywhere - Learn

Workday package Easily automate your Workday processes such as
reporting, data upload/download, or triggering
workflows with our new point-and-click experience.
Our new package provides deep API-level
integration with Workday that enables you to build
automations easily, without having to code.
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Enhance developer productivity Next-gen Recorder: Improve automation reliability for
web applications when the UI element is not visible
on the screen. The Recorder will automatically work
around this without any developer intervention.

Email automation through a shared mailbox: Automate
email tasks over a shared mailbox in Microsoft 365
Outlook using IMAP or EWS protocols and Client
Credential flow or PKCE flow with Exchange Online.
This feature saves you money, time, and effort in
maintaining individual personal mailboxes.
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Quickly search and replace any text or variables in the
action properties of the bot: Save time and improve
developer productivity with an automatic search
and replace tool in Bot Assistant. Users can quickly
search for any specific text or variable, navigate
through the search results, and selectively replace
each occurrence of the text or variable in the
automation.
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Bot runtime alerts: Gain visibility into your
automations with notifications on various
platform events and take actions based on these
notifications. Get notified on events such as
automation runtime and device pools from within
the application (default) or through email reports
based on your preference.
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Enhancement to bulk package update: As an
automation administrator, update multiple packages
in bulk or perform updates to specific bots and view
outcomes of these applied updates in a system-
generated report.
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What's new and changed in each product

Navigate to the following pages for details on all the updates (what's new, changed, fixed, and limitations)
in each product:

RPA Workspace v.28 release on page 73

CoE Manager v.28 release on page 90

AARI v.28 release on page 90

IQ Bot and Document Automation v.28 release on page 93

Bot Insight v.28 release on page 96
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RPA Workspace v.28 release
Review what's new and changed, and the fixes and limitations in RPA Workspace for the v.28 release.

Novità

Control Room, devices, and Bot Agent

Select the Control Room services to run at startup (Service Cloud case ID: 00781074,
00804237, 00799057, 01260425, 01271130, 01793867)
You can optimize application process utilization on your device by selecting the Control Room
services that you want to automatically run at startup during the On-Premises installation.

Improved notifications administration to manage user access
A Control Room administrator can manage a user's access to the event categories set in the
Administration > Settings > Notification settings section. A Control Room administrator can
lock the required preferences and notifications only for those enabled event categories are sent to
the end users.

Monitor bot runtime, device pool, and license events through notifications
Through notifications, you can monitor all
• Bot runtime events: Bot runtime event notifications are sent to the respective users based on

bot access permissions.
• Device pool related events: Device pool-related event notifications are sent to users based on

their user role and permission in the Control Room.
• License events (such as license over subscription or consumption) - Email notifications are sent

for license over subscription or consumption events.

Monitor AARI events through Control Room notifications
With the Process events category, the Control Room notifies you about various AARI events
related to requests and tasks through notifications. The task and request event notifications are
sent to the task owner and request creator team, respectively.

Audit log event when a package is deleted (Service Cloud case ID: 01780700, 01885638)
An audit log event is logged when a user deletes a package.

Import intermediate certificates for secure access to Control Room (Service Cloud case
ID: 00673966, 01889608)
An intermediate certificate is used to determine if a certificate was issued by a valid and trusted
root CA (certificate authority). If the intermediate certificate is not installed on the server where the
TLS certificate is installed, applications might not trust the TLS certificate. To have clients trust the
TLS certificate, you must make the intermediate certificates available on the server.
You can import the intermediate certificates when you install the Control Room or after you install
the Control Room using the Windows command prompt.

© 2023 Automation Anywhere. All rights reserved.     73



    Automation Anywhere - Learn

Control Room, devices, and Bot Agent

Validate remote deployments to avoid unauthorized device access (Service Cloud case ID:
01608589)
Prior to assigning a device for bot deployment, you can reset the bot running device for Bot
Creator, Citizen Developer, and attended Bot Runner users to prevent unauthorized deployments.
This enhancement enables you to clear an existing bot running device when users log into the
Control Room and there is no Bot Agent available on the local device.

Configure username for different Automation 360 services using the CyberArk secret
response (Service Cloud case ID: 01852428, 00675147, 01950039, 00819460, 00830696,
00822765)
You can configure usernames for auto-login, Lightweight Directory Access Protocol (LDAP), and
service credentials using the CyberArk secret response. Usernames can be a combination of values
from the secret response or string literals. The CyberArk secret response contains field values that
you must enclose within dollar signs ($$) to construct the username. For example, to configure the
username in the format domain\username, you must enter: $$domain$$\$$username$$. The
domain and username values in this expression will be replaced with the corresponding values from
the secret response.

Customize device registration settings
Control Room administrator can customize the device registration settings while adding a device.
For example, if there are multiple users who will log into a single device, an administrator can
change the Device type to Multiple users.

Minimize security risk for trigger-based bot deployment
Prior to deploying a trigger-based bot, you can select to validate the device credentials for Bot
Creator, Citizen Developer, and attended and unattended Bot Runner users. This provides users
additional security for trigger-based bot deployment.

Auto-connect to non-UI triggers for unattended users
As an unattended user who uses non-UI triggers (such as File/Folder trigger that do not require
user session) you can auto-connect to the RPA Workspace when the machine is rebooted. You do
not need to log in to ensure the triggers are running.
Service Cloud case ID: 00758775, 01754312, 01754887,01803179, 01844357,
01845563,01568082, 01866287, 01920491, 01951355, 01951355, 01957771

Packages, actions e Bot editor

Workday package
You can use the new Workday package from Automation 360 to automate your Workday processes
such as reporting, data upload/download, or triggering workflows with our new point-and-click
experience. The package provides deep API-level integration with Workday that enables you to
build automations easily, without having to code.

Apigee package
You can use the new Disconnect and Resume Integration features in the Apigee package. You can
disconnect from your Apigee instance and clear the session using the Apigee Disconnect action. You
can resume an integration that is suspended in Apigee using the Apigee Resume Integration action.

© 2023 Automation Anywhere. All rights reserved.     74



    Automation Anywhere - Learn

Packages, actions e Bot editor

View mode supports the ability to copy
You can use the Copy to shared clipboard functionality to copy actions, triggers, and metadata
from a bot in a private repository that is in View mode. You can then use the Paste from shared
clipboard to paste the information to an editable bot.

Credential Picker listing enhancement
For easier navigation when you pick a credential, the Credential Picket option displays the
Locker, Credential and Attributes items alphabetically across the bot packages.

Extended attributes supported in the Terminal Emulator Package (Service Cloud case ID:
01870633, 01928396, 01809815)
The TN3270E terminal type supports extended attributes. To enable extended attributes for
TN3270E terminals, select the Extended Attribute check box in the Connect action.

Enhanced Packages landing page
The Package Manager landing page has been enhanced to provide more clarity with consolidated
rows. When all versions of a package are disabled the status displays as Disabled. All related
fields, such as recommended Control Room version, Bot Agent version, and Last modified, will show
the status as Not Available.
The Version column has been renamed to Default version.

Enhanced error messages display errors from the child bots (Service Cloud case ID:
01264352)
When you create a bot where the parent bot calls a child bot, and if an error occurs in the child bot,
the error message provides the following details:
• Line number of the parent bot which ran the child bot.
• Line number of the child bot where the error occurred.
• Error message details, such as what went wrong with that line number and the corresponding

corrective action.

Timeout option in Database Connect action (Service Cloud case ID: 00753858)
We added a timeout option in the Connect action of the Database Package. When you connect
with Microsoft SQL Server to automate database-related tasks, and if the database is down or
experiences any network issues, the automation will time out and fail if the database connection is
not established in the specified time.
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Packages, actions e Bot editor

Improved readability with new formatting capabilities in XML document (Service Cloud
case ID: 01886455, 01925386)
When you insert, update, or delete nodes, the XML package does not remove carriage return
characters between nodes but does remove all blank text nodes from the XML document. By using
Prettyprint to format XML files, developers can easily improve the readability of a document.
Developers can save time by using the following new options that have been added to the XML
Package:
• Use Prettyprint: The Save session data action supports the Prettyprint format in the XML

document. When you select the Use Prettyprint check box and use the Insert node, Update
node, or Delete node actions and then save the XML document, the code is formatted with
proper indentation as per Prettyprint.

• Remove text nodes that contain only white space: The Start Session action provides an
option to remove blank text nodes when you parse the XML document.

New features added to the Email Package (Service Cloud case ID: 01835214, 01846425,
01756713, 01882482)
To support extensive process automation, we added the following action-related features to the
Email Package:
• Ability to use the Reply All action.
• Enhanced the Delete all action to delete all emails from a specific folder. Additionally, you can

apply filter parameters to emails such as:
• All, Read, and Unread
• Subject
• From a specific sender
• Before, on, or after a received date

• The dictionary variable for email properties includes a new variable, emailNoOfAttachments, used
to retrieve the attachment count.

Automate controls using Microsoft UI Automation (COM) technology
You can use the Microsoft UI Automation (COM) technology to automate the following scenarios:
• Capture and automate link controls
• Capture and automate tree controls

Insert Custom column in Data Table
A new Custom column option has been added to the Data Table > Insert column action that
enables you to insert a new column at a specified index in a data table. When you read an Excel
spreadsheet and assign it to a data table, you can modify the table by adding a new column and
entering any required data.

New Label option in Loop package
A new Label option has been added to the Loop package that enables you to break or continue a
specific loop from the nested loops.

Add and configure If action conditions
You can add and configure a maximum of 32 conditions in a single If action.
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Packages, actions e Bot editor

Improved automation reliability for web applications
When you use the Recorder > Capture action to automate web pages running on Google Chrome
and Microsoft Edge browsers, the Recorder > Capture action no longer scrolls down the web
page if the target object is visible on the screen. By having a fixed top pane on the web page, the
user experience and automation reliability are improved particularly if some physical actions (such
as mouse clicks) do not work as expected.

Note:  Ensure that you install the browser extension (version 3.0.8.0) and use the Recorder
package (version 2.10.2) to capture the control.

Preferred view retained as default view in the Bot editor
As a bot developer, you no longer have to manually select the preferred view when you open the
Bot editor. To improve the developer's productivity and user experience, when creating bots in
the Bot editor, your preferred view (List, Flow, or Dual) in the Bot editor will persist across user
sessions and browsers. When you navigate in the Control Room or after your next log in, the Bot
editor will retain your last used or selected view.

Line markers for collapsible sections of code in the Bot editor
When you create bots using Loop, If/If-else, Step, Trigger-loop, Try, Catch, and Finally
statements, the Bot editor clearly shows the collapsible sections. When building automations,
developers can use these visual indicator line markers at the beginning and end of the collapsible
section to improve their productivity.

Note:  The visual indicator line marker for the collapsible section applies only to the List view in
the Bot editor.

Enhanced user experience through refreshed and intuitive icons
With the new and intuitive icons for actions in the Bot editor, Citizen Developers and RPA
developers can quickly locate the correct action while creating automation for a day-to-day task.
These unique and renewed icons are developed according to brand and global standards.

Update to the Capture text of window action
The Capture text of window action in the App Integration package can be used to capture a text
from a window on two different user sessions.

Search and replace in Bot editor (Service Cloud case ID: 00792784, 01943783)
Use the Search and replace feature in the Bot editor to search for any text or variables, string
within an action and replace it.

The experience of building a process has improved.
• Copy, cut, and paste behaviors are the same in Process Composer as in the Bot editor.
• You can access hidden variables for all applicable conditions, through the variable picker in the

Process Composer.

The Process Composer supports Global Values. You can enter Global Values as variables and select
them from the variable picker.
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Packages, actions e Bot editor

Upload Storage file action added to Process Composer package
You can use the new Upload Storage file action in a task bot to upload data to storage for further
consumption in a process. This makes AARI requests more versatile by enabling bots to process
files rather than requiring users to upload at request creation.

Building and running bots

Notification for bot import
You are informed through Notifications when you import a bot from the Control Room. However,
this notification is sent only to the user who imported the bot.

Bulk update of multiple packages to default version for multiple bots (Service Cloud
case ID: 00712719, 00728499, 00737694, 00803673, 01255722, 00838604, 00772147, 01760236,
01762679, 01771416, 01761859, 01782588, 01778220, 01784255, 01789551, 01809167,
01818690, 01831969, 01813413, 01287311, 01923711, 01927867, 01945464, 01946912,
01819540, 01945315)
You can update multiple packages to default version for multiple bots. This feature enables you to
update multiple package versions across all available bots with one action thereby increasing the
efficiency of a bulk package update. Additionally, you can review the bots and dependencies before
a bulk update.

Enhancements to code analysis
• You can access the new administration settings tab for policy management. The enable or

disable functionality of code analysis has been moved from Administration > Policies to
Administration > Settings > Policies.

• You can define multiple named policies with different rules that have different severity levels.
• You can apply different policies to different folders in the Automation page. When you run

code analysis on a file, it uses the applicable policy for the folder (assigned or inherited) where
the file is located.

Notifications integration in embedded automations
Notifications in embedded automations (such as Workday, Salesforce) provide you information
about automations initiated from these applications and remote bot executions. It enhances the
user experience by notifying you about the remote bot executions in their respective applications,
thereby increasing the notifications effectiveness.
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Building and running bots

Enhanced Automation Command Centre home page
The Automation Command Center (ACC) home page provides comprehensive visibility, actionable
insight, and oversight capability into all aspects of your automation domain. The ACC home page
provides operational insights such as automation and device status, license utilization information,
and code analysis policy compliance metrics.
This enhanced home page provides the following benefits and capabilities:
• Effective monitoring of the automation landscape, leading to:

• Improved reliability
• Improved utilization

• Ensures compliance by highlighting results of code analysis
• Helps CoEs scale efficiently and achieve automation success
• Easier navigation to other areas such as AARI, CoE Manager, and Bot Insight

APIs and integrations

Export repository bots by version or label (Service cloud case ID: 01805699, 01838251)
Use the new POST /v2/blm/export/version API to export repository bots by specifying the
label or version of the files. These bots are exported to an archived file.

Process composer APIs
Use the Process Composer APIs to create a new request from AARI processes. You can also
retrieve the initial form and request by specifying the reference ID. You can use the following
endpoints in the process composer APIs:
• /requests/create: Create a new AARI request.
• /requests/ref/{refId}: Retrieve a request.
• /processes/{id}/form: Retrieve initial form.

Cosa è cambiato

Control Room, devices, and Bot Agent

Improved secure registration for Community Edition or Automation 360 users
When a user registers for the Community Edition or Automation 360 account, the registration email
sent to the user contains a temporary registration link used to create the user credentials. This
registration method is more secure than sending the user their password in plain text.
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Control Room, devices, and Bot Agent

Licenses page enhancements
To provide easy access to license usage and availability, the Licenses page includes information for
the following elements:
• License mode
• Control Room expiration date and time
• Date when the Licenses page was last updated
• List of products with license availability
• License total details and where used

Upgrade changes in code analysis policy from Automation 360 v.28 or later versions
If you have configured a policy for code analysis prior to upgrading to Automation 360 v.28, this
policy is migrated to Automation 360 v.28 and is named default policy. This policy is applied to the
Automation root folder and is applicable for all bots prior to Automation 360 v.28 release.

Active Directory enhancements for configuring domains (Service cloud case ID: 00733422,
01853744, 01862164, 01794663)
The following enhancements were made for administrators who configure domains for Active
Directory (AD):
• The Control Room login and the Create user pages automatically select the default domain that

is configured. You can select a different domain by either entering the letters of the domain or
selecting the domain from the drop-down list.

• You can configure the domains listed on the Control Room login, the Create user, and the
Create an Active Directory role mappings pages to hide domains.

Support for multiple roles in Active Directory role mappings (Service cloud case ID:
01133364, 01133364, 01929400, 01776684)
When you create multiple Active Directory (AD) role mappings for multiple security groups, the
roles used in the mappings are combined for the users who belong to the security groups.

Users who have an Attended Bot Runner license can no longer add Bot deployments to a queue.
However, there are no changes for triggers.

Packages, actions e Bot editor

The name of the AARI Web package has been changed to Process Composer.

Correzioni

Control Room now sends email notifications when a scheduled bot fails prior to its execution for
example, when the Bot Runner machine is not available.
Service Cloud case ID: 01768120
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The Schedule column on the Scheduled activity page shows the frequency of a scheduled bot in
your local language.
Previously, the frequency of a scheduled bot was not translated and not shown in the user's local
language, for example, Japanese.
Service Cloud case ID: 01936850

When you restart the Control Room services and execute a bot, the bot deployment no longer fails
on the connected devices nor generates an error on the In progress and Audit log pages.
Previously, the AtmosphereResource Cancelled error displayed on the In progress page and
the error was registered on the Audit log page.
Service Cloud case ID: 01937388

You no longer see duplicate deployments (current and previous) for the same device on the In
Progress page.
Previously, duplicate deployments were displayed.
Service Cloud case ID: 01954716

When you create a locker, the Create locker page displays tabs such as Credentials, Owners,
Managers, and so on.
Previously, tabs were not displayed.
Service Cloud case ID: 01949499

Attended Bot Runner users can view the Schedule bot menu on the following pages:
• Automation (Run bot > Schedule bot)
• In progress activity
• Scheduled activity
• Devices
• Device pools

Previously, this menu was not displayed on these pages.
Service Cloud case ID: 01085127, 01805063

If you deploy a task with a Bot Runner that has a disconnected default device and no device pool is
selected, an error message displays in your local language.
Previously, an error message displayed in English even when the user's local language (for example,
Japanese) was selected.
Service Cloud case ID: 01919213

The Bot Runner device will unregister from the Control Room only if there is a valid authentication
error.
Previously, during the Bot Runner authentication, the device was unregistered from the Control
Room after two unsuccessful authentication attempts. The reason for the error could be due to a
valid unsuccessful authentication attempt or any other error.
Service Cloud case ID: 01947943, 01946249, 01956026, 01945438
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You no longer encounter issues when you create a bot using the DLL Open and Close actions and
then use the If > Dll session exists condition to check whether a DLL session is closed in a bot.
Previously when you used the If > Dll session exists condition, it failed to check a closed DLL
session and displayed an error.
Service Cloud case ID: 01868691

When you use the Get node value to retrieve the JSON object in the JSON package, it returns the
JSON value in the correct format.
Previously, the Get node value action displayed the output in the wrong format.
Service Cloud case ID: 01864551

You can use the Connect action to establish a connection with the FTP/SFTP server with keyfile
authentication and automate a task.
Previously, the bot could not automate the FTP/SFTP operations if the SFTP keyfile server was
installed on a Windows machine.
Service Cloud case ID: 01858323

You no longer encounter any errors when you create a bot using the Create workbook action
from the Google Sheets package.
Service Cloud case ID: 01918952

When you use the Connect action in the Active Directory package, you can select objects in the
Object Explorer window successfully.
Previously, an error was displayed when you selected objects in the Object Explorer window.
Service Cloud case ID: 01925109

In the Email package, you can use the Email > Send action to send an email without issues.
Previously, when you used Email package version 3.14.3-20220923-220748 or later, an issue
occurred when using the Email > Send action.
Service Cloud case ID: 01912097, 01931592, 01934137, 01940215, 01932494, 01942202,
01942055, 01946339, 01949164

You can create bots using the Run stored procedure action of the Database package even when
you include a large amount of data as an Input parameter.

When you use the Connect action of the Terminal Emulator package with the prompt value and
then the Wait action, the Wait action waits for the prompt value to appear on the terminal screen.

When a new package (first version) is added to the Control Room and you select Disable setting
for the new version of the package, the package will show the status as Disabled.
Previously, it showed the status as Enabled and set as default.

In the Datetime > Add action, you can now specify a fraction value in the Time value to add
field to increase the value in the Datetime variable by that specific fraction value.
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When you use any browser action to automate a browser window or a tab, and run the bot, the
browser action now waits for the time specified in the Time out after field to execute action on
the browser tab before the bot fails. Previously, the browser action failed after 30 seconds when the
bot did not execute successfully, regardless of the wait time set in the Time out after field was
less than or greater than 30 seconds.

Note:
• As a result of this fix, if the Time out after field has a value other than 30 seconds, you might

have to change the value for your existing bots. This will ensure that your bots continue to run
properly with the latest Browser package.

• This fix does not apply for the Find broken links action.

Service Cloud case ID: 01880159

When you perform the following sequence of actions and then rename the variable that was used
in these actions, the name of the variable will now be updated for the Group conditions and the
conditions in the Condition tab:
• Use the If package
• Add a specific condition with a variable
• Add a specific condition with a variable
• Salva il bot.

In the Datetime > Subtract action you can now specify a fraction value in the Time unit to
subtract field to decrease the value in the Datetime variable by a specific time value and unit.

When you use the Capture action with the Recorder package (version 2.9.x or earlier) to navigate
to another web page in the Google Chrome browser (version 105.0 or later), and then use another
Capture action to automate objects in the navigated web page, the bot no longer encounters an
error.

In any package, when you select the Add argument option, select String or Number as the
Argument type, and try to insert a value, you can now use the mouse to scroll or click the scroll
bar to navigate through the options.

When you use multiple Recorder actions in a bot to automate a specific web page running in
Microsoft Edge with IE mode, and then run the bot, the second Recorder action now works
properly, and the bot no longer encounters an error.
Service Cloud case ID: 01848824, 01868337

You can now use the Folder > Unzip action to extract compressed files and folders from an
AES-256 encrypted zip file.
Service Cloud case ID: 01854767

When you try to automate web applications, the Click action in the Recorder now works properly
with the MV3 extension on Google Chrome and Microsoft Edge browsers. Previously, when the
object on a web page contained inline JavaScripts and the document to be automated was secured,
the Recorder failed to perform the Click action.
Service Cloud case ID: 01927058, 01951022
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When you use the Click action in the Recorder to automate applications running on Microsoft Edge
with IE mode, the bots now time out automatically and no longer freeze when a pop-up appears
during bot execution.
Service Cloud case ID: 01790352

When you assign a Production label to a TaskBot and deploy it, the bot no longer encounters an
error at the Image Recognition > Find window in window action and runs successfully.
Service Cloud case ID: 01825541

When you use the Recorder package (version 2.10.2 or later) to capture a control on a web page,
select Currently active window from the Application tab and then run the bot in a loop, the bot
now captures the target control accurately and runs through all the loop iterations successfully even
if the control appears behind the bot runtime window.
Service Cloud case ID: 01904537

When you use any of the following actions to determine if a window does not exist, select the web
page opened in the Google Chrome browser from the list of active tabs in the Browser tab, and
then run the bot, the following actions now wait for the specified time value to close the browser
tabs before the bot fails.
• Window does not exist condition in the If and Loop packages
• Window with same title does not exist condition in the If and Loop packages
• Window does not exist condition in the Wait > Wait for condition action
• Window with same title does not exist condition in the Wait > Wait for condition action
• Wait > Wait for window action

Note:  When you run the bot, the actions might wait for an additional two to three seconds later
than the specified time out value to execute actions before the bot fails.

Service Cloud case ID: 00790336, 00822573, 00832864, 01268577, 01586174, 00790336,
01778857, 01804828, 01809565, 01791209, 01848262, 01867832, 01877740, 01959172, 01959278

When you create or delete a folder (or form) that contains .. characters in the folder (or form)
name, the folder structure no longer affected.
Previously, when you deleted a folder (or form) that contained .. characters in its name, the
parent folder was deleted which caused issues with the folder structure.
Service Cloud case ID: 01886058

The resiliency of the File/Folder trigger has been improved to continue listening after a network
disruption has occurred. Previously, a network error caused the trigger to lose connection with the
Bot Agent.
Service Cloud case ID: 01769532, 01773584, 01834098, 01867418

When you check in a bot that contains the string "bot_" in its name and some recorder metadata,
the metadata is no longer deleted. As a result, you can check out a bot without generating an
exception or error message.
Previously, the recorder metadata was deleted and you were blocked from making recorder
changes to any of the bots that contain "bot_" in its name. The bot checkout failed and generated
an exception or error message.
Service Cloud case ID: 01915726, 01933409, 01939124, 01944665, 01939124
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When you upgrade the Control Room to Automation 360 v.27, the work items are deployed
successfully for all scenarios.
Previously, when you upgraded the Control Room to Automation 360 v.27, the work item failed to
deploy when queues were paused or stopped.
Service Cloud case ID: 01948038, 01950948

When you run a bot with a queue and select the queue category, the task bot (that contains
a TABLE type variable and no row data) no longer fails and shows the Missing work item
template error message.
Previously, when there was no row content for a TABLE type variable, you could not select
the queue category while running a bot with a queue. As a result, the Missing work item
template error message was shown even if a template was mapped.
Service Cloud case ID: 01922641

When you compare bot versions from the View history Task Bot page in the public workspace,
the Compare versions displays any modifications made in the latest two versions of your bot
without any error.
Previously, an error was displayed if you used the Compare versions feature through the View
history Task Bot page.
Service Cloud case ID: 01949094, 01946533

After you update the Bot Agent to the 21.240.19897 version, you can deploy multiple bots using the
API without any failure caused by the AA-DB file size.
Previously, when you deployed multiple bots using the API the AA-DB.mv.db and AA-
DB.trace.db file sizes continued to increase and eventually caused the bots to fail. Additionally,
the device configuration refresh initiated message continuously displayed.
Service Cloud case ID: 01776544

The following issues were fixed on the In progress activity page:
• Active bot deployments no longer disappear after a page refresh.
• Duplicate bot entries were removed whose status was displayed as active.

Service Cloud case ID: 01937581

Variables that you configure as input type are encrypted in the log files generated for Control Room.
Previously, input type variables were not encrypted and displayed as plain text in the log files.
Service Cloud case ID: 01768904

Users can only view activities to which they have permission on the Activity > In progress page.
Previously, some users were able to view the activities of other users even though they did not
have permission.
Service Cloud case ID: 01839276, 01919244, 01940793, 01941503

In attended and unattended automation, if a bot fails to run and generates the "Node Manager
went Down unexpectedly and could not complete this bot execution." error, the start time on the
Historical and Audit log pages display correctly.
Previously, the start time was displayed incorrectly.
Service Cloud case ID: 01881736
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All users can view the scheduled activities on the Scheduled activity page.
Previously, some users were unable to view the scheduled activities.
Service Cloud case ID: 01885890, 01848429

The Control Room Access URL length is set to a maximum of 4,000 characters.
Previously, the URL length was not set.
Service Cloud case ID: 01923035

Sorting users using the Last login option on the Users page sorts users correctly.
Previously, sorting users by last login was not sorting the users correctly.
Service Cloud case ID: 01813134

If you have created a bot using the Rest API command, the REST GET command is parsed without
any errors even when the response body is empty.
Service Cloud case ID: 01922332

Japanese characters are supported in the Rest commands with multipart/form-data option and the
output PDF name is rendered correctly.
Service Cloud case ID: 01909753

All the files in the specified OneDrive location is downloaded successfully when you use the
Download file action from Office 365 OneDrive package.
Service Cloud case ID: 01886501

If you have selected the Read cell value option in the Read row action of the Excel advanced
package, the data from the next sheet of the specified excel file is extracted correctly using Switch
to sheet action.
Service Cloud case ID: 01904504

If a bot has Get multiple cells or Get Single Cell action from the Excel advanced package to get
the underlying scientific values, the values from the specified excel file are successfully extracted
when you run this bot.
Service Cloud case ID: 01882225, 01938812
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After updating to this release, exception errors are no longer displayed for the following actions in
the Excel advance package:
• Get single cell
• Get cell color
• Get multiple cell
• Get number of cells
• Get worksheet as data table
• Insert/Delete rows/columns
• Read cell formula
• Read column
• Read row
• Remove blank row
• Rename worksheet
• Replace
• Select cells/rows/columns
• Set call
• Switch to sheet
• Chiudi

Service Cloud case ID: 01780178, 01926325

If there are many (more than 500) bots deployed in one of the device when there are multiple
devices connected to a Control Room, bot deployments across other devices are no longer blocked.
Service Cloud case ID: 01791784, 01950118, 01904686, 01795862, 01945357, 01941048

If you create a folder with the same name as an existing folder in the private workspace, an error
message is now displayed, and the folder is not created.
Previously, a false successful folder creation message was displayed, but the last modified date of
that particular folder remained the same as that of the previously existing folder.

When you create, view, or edit roles and then navigate to the Bots section, the folder list is sorted
alphabetically making it easier to find a specific folder.
Previously, the folders were not sorted alphabetically, and it was difficult to find a particular folder
when there were many folders in the repository.
Service Cloud case ID: 01762755, 01843015, 01874823

When you import a bot using the overwrite option and do not have permission to access one or
more dependent folders, the import dependency is not broken because of the import failure on the
dependent folder.
Previously, importing the bot when you had no permission to access the dependent folder resulted
in a break in the dependency if the file or folder was already present.
Service Cloud case ID: 01929592, 01946078

When you import a bot that has more than 2,100 manual dependencies, the import is successful
without any issues.
Previously, the bot import failed when the bot contained more than 2,100 manual dependencies.
You had to reduce the number of dependencies to import the bot successfully.
Service Cloud case ID: 01913648, 01942373
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The group Managed Service Account (gMSA) provides functionalities such as install, update and
LDAP authentication within a domain, and also extends it across multiple servers.

Limitazioni

(ID caso Service Cloud: 01833352)
When you want to move emails from one folder to another, and if you apply multiple filters such as
Subject, From specific sender, When received date is on or after, or When received date
is before, you cannot move an email when its sender id is: noreply@**.com.

Note:  You might observe this issue when you use Save All attachments, Delete All, Move All,
and Loop actions.

Soluzione: Use only the From specific sender filter to move emails.

The Create User audit log entry page shows a valid device license even when the license
allocation for a user had failed.

In a clustered environment, when you update bots to the default package versions, the Bot
update list page shows Failed status and bots are auto-checked out even if they are updated
with the latest default packages.

In an Oracle environment, the Bot update list page shows an Code:
db.connection.exception error message.
Soluzione:
1. Log in as an administrator.
2. Navigate to Manage > Packages and set the required package version as the default version.
3. Log in as a Bot Creator, and then check out and edit the bot.
4. In the Bot editor, click the three vertical ellipses at the top right corner.
5. Select required Packages and update the package version manually.

While updating bots to the default package version, when you select the Production label bots,
the package update is applied for the latest version of bots instead of the Production label bots.
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When you check out and edit a bot after the bot updates to the default package version, an error
is displayed in the System Date for these commands: SystemsDate, REST Web Service, and
Number.
Soluzione:
1. Edit the bot and navigate to Manage > Packages.
2. Set the Date and Time for the non-default package, and then set it back to the default Date

and Time.

Note:
• If previous version of the package does not exist, then upload the package and assign the

default Date and Time.
• If previous version of package is available, then edit the bot, assign it to the previous

package and save. Then, re-assign the bot to the new default package.

When a user (who created the workload automation) is deleted, work items are not processed even
if they are available to process. As a result, you must delete and re-create the automation.

If you select the Search type as Variable name in the Search and replace feature, the content
is not replaced when you use a number variable in the expression.
Soluzione: To replace a specific variable in number expression, open that action and change the
variable manually.

(ID caso Service Cloud: 01950021) If Auto update is enabled for the Bot Agent in Control Room,
registered devices running Windows10 Enterprise might restart intermittently after the Bot Agent
update has completed.

Associated bot deployments fail if the Log collector option was enabled while updating
Automation Anywhere Control Room to this release.
Soluzione: Ensure that the Log collector option under Administration > Settings > Devices
is disabled before updating to this release.

Limitazioni rispetto alle versioni precedenti

While running a bot in debug mode, the bot will fail if the variable size gets greater than 3 MB. An
error message appears showing that a variable has exceeded the 3 MB limit.

Feature deprecations

Review features and capabilities (from Automation Anywhere or other third-party vendors) that are
deprecated or nearing deprecation to understand how they impact your automation.

Deprecated weaker Transport Layer Security protocols: TLS 1.0 and TLS 1.1
Automation Anywhere has deprecated weaker communication protocols TLS 1.0 and TLS 1.1, and
their corresponding ciphers (Cryptographic algorithms) in Automation 360 Cloud deployments (AWS
and GCP). Automation 360 Cloud deployments support TLS 1.2 and later versions only.
Feature deprecations affecting Automation Anywhere products on page 759
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CoE Manager v.28 release
Review what's new and changed, and the fixes and limitations in CoE Manager for the v.28 release.

Novità

Access CoE Manager from the Control Room
As an administrator, you can enable access to CoE Manager from the Control Room. This enhances
the user experience because the user no longer needs to open CoE Manager through a separate
browser tab. Once CoE Manager is enabled, users can directly access the CoE Manager login page
from the quick link section on the Control Room home page.

Support for ROI tracking in On-Premises Control Room
You can integrate both the Cloud and the On-Premises Control Room with the CoE Manager. This
enables you to monitor your automations and analyze the savings achieved. You can connect up to
3 Control Room instances in your CoE Manager.
For the On-Premises Control Room, to upload the bot activity data from the Control Room to the
CoE Manager, download and run the CoE Manager bot available in the Bot Store. To run this bot,
you must have a valid license such as a Bot Creator, Bot Runner, or a Citizen Developer.

Cosa è cambiato

AARI v.28 release
Review what's new and changed, and the fixes and limitations in AARI for the v.28 release.

Novità

Enhanced automation experience for Embedded Automation
We have improved the automation experience for your automation activities to run attended bots:
• As a prerequisite, you must have the Manage my activity permission to use the bot controls.
• When you run your attended automation, its progress, execution status, and controls for

pause, start (resume), and stop, are located on the new progress page inside the Embedded
Automation application.

• You can easily switch between the Automation tab to execute additional automations and
navigate back to the progress view, to monitor the running automations.
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Platform alerts and notifications
You will be notified with real-time message alerts based on recent automation events that occurred
Embedded Automation.
• The Notifications tab in the Embedded Automation will alert you of your automation outcomes

(failed, successful) and provide as detailed information for each bot, such as the start and end
times.

• When required, there is a short message describing if any specific issues occured.
• The New task assigned message will notify you if any new tasks were assigned to you, and

you can click that alert message to be redirected to the newly assigned tasks.
• Similarly, if you receive multiple new notifications, you can click the Load New Notification

message, located at the top of the notification list, to load additional unread notifications.

Stationary action buttons
While completing forms in AARI, action buttons are positioned in the fixed footer of the form. The
footer and its contents are responsive to the size of your window and adjust to fit buttons and
minimize the footprint.

Cosa è cambiato

Enhancements to tags in embedded widget
These tag improvements provide a more accurate search and save you time when searching for
available tags:
• You can select and manage up to 500 tags at a time, in tag selector.
• Your search results will vary depending on the number of search terms you use with the most

recently created tags always showing at the top.
• You can use the search all tags option to search for all available tags.

Process level URL parameters
These process level URL improvements make it easier for you to pass URL data to your requests:
• You can pass custom data from applications to requests.
• Supported data types include: dates, time, number, text box, check box, radio button, text area,

and drop-down.
• Hidden variable types in a form are supported to receive URL data.

Improved formatting options for Label element
The Label element has been improved with new formatting properties where you can configure the
font sizes, colors, and text alignments in a form.

The name of the Process Editor has been changed to Process Composer to better reflect its
comprehensive capabilities.

Forms have improved responsiveness due to this next generation of form rendering technology.
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Users receive a notification in the Warning tab when a task is assigned or reassigned to them.
Service Cloud case ID: 01869263

Correzioni

When you use a table element in your form which contains a text area data type, the text area
generates data from the database without issues.
Service Cloud case ID: 01905252

In a table cell field, when you enter Chinese, Japanese, and Korean characters, the characters
renders correctly.
Service Cloud case ID: 01914818

When you create a form with a column width that is less than 20% in Automation 360 v.26 amd
you open the form in the current version, the will now render without issues.
Service Cloud case ID: 01944387

In an AARI process, when you use the if/else condition, a process error no longer occurs when
you add the else if condition after the if condition.
Service Cloud case ID: 01949808

In AARI Web forms, the text area size renders as specified. Previously, the height did not render as
designed.
Service Cloud case ID: 01911488, 01910936, 01914476, 01924252, 01929268, 01946479,
01958805, 01961238

When filtering AARI requests by date, the date displays correctly.
Service Cloud case ID: 01915259

AARI forms works as expected when adding a new rule to an existing form.
Service Cloud case ID: 01925778

In AARI Assistant, the last runtime information no longer causes performance issues.

Limitazioni

When you use the Search and Replace option to replace a form variable in a bot, the Search and
Replace option does not function properly and cannot locate the form variable.

When using a form with an image, users require the View permission to access the image and have
it render in forms.
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IQ Bot and Document Automation v.28 release
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.28 release.

Document Automation

Novità

Standardize the format of extracted numbers and dates
You can configure your learning instances to convert extracted dates and numbers to a standard
format. This ensures consistency and accuracy in your databases and other systems of record.
For example, if you select to standardize dates to MM/DD/YYYY and a processed document
contains a date that appears as 12 Feb 2023, the learning instance will reformat the date to
02/12/2023.
If you select to standardize numbers to the English (United States) locale and a processed
document contains a number that appears as 100,00, the learning instance will reformat the
number as 100.00.

The new Document Workspace license tracks consumption for customers who brought their own
license for Google Document AI or Standard Forms.

New Google Document AI features
• Validation feedback is available for new and existing learning instances that use Google

Document AI to extract data.

Note:  You must manually enable validation feedback for existing learning instances

• The invoices document type supports these additional languages: Estonian, French, German,
Latvian, Lithuanian, Portuguese (Continental), Romanian, Spanish, and Swedish.

• The receipts document type supports Japanese language documents and can extract two new
fields: payment type and last four digits of credit card.

New features for the Document Workspace dashboard in Bot Insight
• Create custom widgets
• The Validator performance by # of documents validated widget includes invalid

documents.
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Cosa è cambiato

Download bots have the highest priority in a queue
To optimize system performance, the Control Room prioritizes running the download bot of
one process before running the extraction bot for another process. Previously, the system was
configured with the extraction bots at equal priority to the download bots, which created a large
queue of extracted data waiting to download.

Note:  For users with Control Room environments configured prior to v.28: The Control
Room admin must edit the aari-document-processor custom role to assign the new Set
automation priority to high permission.

Important:  New Community Edition users will have access to Document Automation
but not IQ Bot
As of Automation 360 v.27 release and later, only Document Automation will be provisioned to new
Community Edition users. New users will not have IQ Bot permissions, however, IQ Bot will be
available for existing, registered users.

Correzioni

When you create a learning instance, the interface allows field names that start with a letter only.
Previously, the interface allowed field names to start with a number, which caused processing
errors.

The Test regular expression field supports a maximum of 100 characters.

You can create a learning instance with custom fields that do not have a field name and field label,
as long as the custom fields are unselected.

Document Automation extracts multiline fields without adding an extra space after each line.

Document Automation supports document processing on devices configured with an authenticated
or unauthenticated Proxy Auto-Configuration (PAC) file.

The Document Workspace dashboard shows the correct page consumption metrics for On-Premises
Control Room instances.

The "Average validation time" and "Validator performance by number of documents" widgets show
the correct values when you mouse over the data points.

In Document Automation, the correct error message is displayed while fetching a Standard Forms
model that is missing configuration settings. Previously, an incorrect error message was displayed.

While reconfiguring a table, you can add a table name within the 99 character limit and a table field
name within the 154 character limit. Previously, you could add more characters than the default
limit of 100 characters and 155 characters, respectively.

You can create a new project for Standard Forms in the Linux environment. Previously, the ability to
create a project using Create project for Standard Forms was not supported in Linux.

Limitazioni

Document Automation supporta un nome utente dispositivo di 17 caratteri o meno.
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Limitazioni

Pattern-based validation is not enabled by default in imported learning instances. You must edit the
learning instance and select the Validation option in the Validation rules section.

Bots containing actions from the Document Extraction package do not support the advanced check-
out options.

For a public learning instance, if you delete a learning instance and then try to create a new
learning instance using that same name, an error is displayed.
Workaround:If you delete a learning instance as well as the learning instance folder, then you can
create a new learning instance using the same name.

When you create a learning instance with Google Document AI, an UNKNOWN option is
displayed under the OCR Engine filter in the Document Workspace dashboard.

If you apply a filter that includes User Name, Status, or OCR Engine, the Accuracy% by field
widget does not show the correct results.

If you submit a document that contains a validation error due to a regular expression, the page
keeps loading and you must refresh the page to continue. You cannot submit a document that has
a pattern validation rule with a regular expression that contains pipe symbol (|).
For example, the following expression has (|) characters and will show an error:
(^0[1-9]|[12][0-9]|3[01])-(0[1-9]|1[0-2])-(\d{4}$)
However, you can edit the regular expression in the learning instance and reprocess the document
to continue with validation.

As of Automation 360 v.28, document extraction fails via proxy in the bring your own key (BYOK)
use case.

IQ Bot

Correzioni

If you test an invalid Python script when configuring custom logic, the system displays an error
message without any file path. Previously, the error message included the execution file path.

When you upload high-resolution or invalid documents to a custom group, if the document is not
processed, it is either moved to the validator folder or the fail folder. You can eventually download
the files from the fail or invalid folder.
Previously, the validator or the fail folder did not receive the uploaded files. You had to transition
the learning instance from production to staging and back again to move the file to the output
folder.
Service Cloud case ID: 01926196

The ability to create or edit a bot for a manual group has been fixed. You can now create a bot with
a manual group that has invalid or corrupted documents. You can also move the created bot from
staging to production and back again.
Previously, after creating a manual group for a learning instance with an invalid or corrupted
document, you were unable to create a bot.
Service Cloud case ID: 01878143
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Limitazioni

If the IQ Bot archive (IQBA) file size is above 268 MB, then the file storage does not upload
the exported file from the output folder to the desired location. You should restart the Project
Services from IQ Bot Services if the system is stuck and you are unable to perform any actions.

If IQ Bot Cloud is configured with a proxy server, learning instances cannot access Google Vision
API or Microsoft Azure Computer Vision OCR engine.

The maximum upload file size limit is set to 2 GB when importing and exporting files in the IQ Bot
archive (IQBA) file. If the file size is greater than 2 GB, then you must delete unwanted groups to
decrease the file size and migrate successfully. Earlier, maximum upload file size limit was 5 GB.

When you change from full screen mode to small screen mode in the Logic window, the Python
scripts and these options are hidden: Test Run, Clear Box, Fullscreen, and Save.
Soluzione:
1. Click Logic to minimize the window
2. Click Logic to expand the window and view the Python scripts.
3. Place a cursor inside the Python script screen and click Enter.

For an existing Community Edition user, the Help icon is not available on IQ Bot interface.

If you are an Automation Anywhere free trial version user and you upgrade to Automation 360 v.28,
the Community Edition logo displays on the homepage. However, the functionality is not impacted.

Bot Insight v.28 release
Review what's new and changed, and the fixes and limitations in Bot Insight for the v.28 release.

Novità

Enhanced Bot Insight filters and widget setting for Document Workspace dashboard
In a Document Workspace dashboard, you can use the custom dashboard filters to build custom
widgets. Additionally, you can edit the widget settings for an effective data visualization.

Correzioni

For Bot Insight business analytics reporting, you can use the Bot Insight APIs to export all the
available data records from the Operations Bots dashboard's DataTable widget.
Previously, you could export a maximum of 100 records at a time from the Operations Bots
dashboard's DataTable widget.
Service Cloud case ID: 00760252, 01819244, 01857905, 01945720
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Bot Insight Operations dashboard (which includes links to the Audit, Bots, and Device dashboards)
now retrieves and shows the complete volume count for a bot run.
Previously, due to a maximum volume count limit in KPI charts, the Bot Insight Operations
dashboard could not retrieve the complete volume count. Additionally, a maximum count of 10,000
was shown as the total bot run in the Bots dashboard which led to incorrect results.
Service Cloud case ID: 01825287

A user with the AAE_Bot Insight Consumer role can only view a published analyze dashboard.
The Delete dashboard action is greyed out and no longer available.
Previously, the Delete action was available and when the user tried to delete a dashboard, an error
message was displayed preventing the user from deleting the dashboard.
Service Cloud case ID: 01870477

Limitazioni

In the Bots dashboard, the Total Bot Runs count does not match what the total count should be
when the Total Completed (Success), Total in Progress, and Total Failed counts are added
together.

Note sulla versione Automation 360 v.27
Data di rilascio: 11 January 2023

Review the top five features in this release and view other new features and exciting enhancements for
Automation 360 v.27 release.
• Build 16701: Automation 360 (Cloud and Cloud Sandbox) and IQ Bot (Cloud)
• Build 16685: Automation 360 (On-Premises) and IQ Bot (On-Premises)

We have released updated builds for fixes after the GA release of v.27 (Build 16667). For information about
the fixes in these updated builds, see Updated release builds alla pagina 99.

Highlights of this release

Here are the top 5 features in the v.27 release:

Embedded smart forms and dynamic data
mapping for embedded widgets

Faster design and use of your embedded automation:
You can now design your forms using a responsive
and real-time canvas that automatically adjusts to
the desired form size. This feature provides a faster
way to create embedded interfaces that interact
with any web applications. You can also configure
these forms in your business applications, such as
Workday or ServiceNow, to securely retrieve data
when embedded as an iFrame widget.
Eliminate data re-entry and save time: Use our new
PostMessage API to map and prepopulate data
from business applications in embedded widgets.
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Dynamic data mapping provides safe and secure
communication of data from your business (host)
applications to initial process forms in the widget.

Consulta Smart embedded forms and dynamic data
mapping alla pagina 2237.

Enhanced citizen developer experience Our updated and intuitive icons enable citizen
developers to quickly select actions and use the
Help for contextual information about actions,
providing a more seamless development of
automations. We have also enhanced the AISense
Recorder user experience so that you can use
anchors easily and automate UI objects that are not
detected by the recorder automatically.

See AISense recorder enhancements.

Strengthen governance and management Notifications: Our new notifications capability
provides a centralized, consistent, and proactive
medium for users to stay informed on their
automation estate and to take actions based on
the events they are alerted on. Alerts on various
platform events, bot events, and other automation
lifecycle events are delivered via in-app (default)
and email (based on user preference).

Consulta Notifiche alla pagina 2913.
Automatically pick available Bot Runner users: Scale
your automations easily by selecting all the Bot
Runner users that can run a given automation
and the number of Bot Runners to use. This
capability ensures that when you run or schedule
an automation, the system automatically picks the
available run-as users from the specified list.

Standard forms Standard forms is now integrated in Document
Automation with the other document processing
capabilities. With enhanced accuracy, this feature
enables you to extract data from densely structured
forms including those with handwritten input. Use
cases for structured documents include tax forms,
mortgages, vehicle registration address, and so on.

Consulta Using Document Automation for Standard
Forms alla pagina 2598.

PEG enhancements We continue to improve our Privacy Enhanced
Gateway (PEG) for sensitive information redaction
with a new configuration UI so you can easily
change the configurations in the UI instead of the
command line. We have also recently released a
new PEG serverless architecture for higher-scale
data collection use cases.
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Consulta Manage redaction and forwarding settings
from the UI alla pagina 2316.

Updated release builds

We have released the following updated builds:
• Build 16701 Service Cloud case ID: 01829572, 01947340, 01949323, 01950696, 01944637,

01951100,01953055, 01950639, 01951722, 01949415, 01949033, 01949372
• Fix for bots that were failing when all of these conditions were met:

• Bot contained more than 2,000 steps
• Bot had one or more nested actions (such as IF or loop)
• At least one of the nested actions contained more than 250 steps

• Fix for inconsistencies that were observed on the In-progress activity page.
• Fix for bots that were failing because of file dependency or interactive form that included multibyte

characters in file names.
• Changes to AARI desktop Assistant to manage and clear automations with start, stop, and resume

actions.

• Build 16685 (for US West, Canada, and Japan regions only) Service Cloud case ID: 01947340
This updated build includes a fix for this issue: If a bot has a file dependency and the file name
contains multibyte characters, then when the Bot Agent downloads the file, the download will fail
during run time causing the bot to fail as well.

What's new and changed in each product

Navigate to the following pages for details on all the updates (what's new, changed, fixed, and limitations)
in each product:

RPA Workspace v.27 release alla pagina 100
• Updating to v.27 release alla pagina 128
• Packages updated in v.27 alla pagina 129
• Migration updates for v.27 release alla pagina 144

Process Discovery v.27 release alla pagina 153

AARI v.27 release alla pagina 154

IQ Bot and Document Automation v.27 release alla pagina 162

Bot Insight v.27 release alla pagina 170

Riferimenti correlati
RPA Workspace v.27 release alla pagina 100
Review what's new and changed, and the fixes and limitations in RPA Workspace for the v.27 release.
Process Discovery v.27 release alla pagina 153
Review what's new in Process Discovery for the v.27 release.
AARI v.27 release alla pagina 154
Review what's new and changed, and the fixes and limitations in AARI for the v.27 release.
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IQ Bot and Document Automation v.27 release alla pagina 162
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.27 release.
Bot Insight v.27 release alla pagina 170
Review the fixes in Bot Insight for the v.27 release.
Packages updated in v.27 alla pagina 129
Review updates to the packages in Automation 360 v.27, including the compatible Control Room and Bot
Agent versions.
Browser extensions for Automation 360 alla pagina 718
Crea automazione dai browser supportati utilizzando le estensioni del browser. Le estensioni sono
aggiornate periodicamente per supportare i miglioramenti e le correzioni delle funzionalità. Pertanto,
assicurati di disporre delle versioni più aggiornate delle estensioni per i browser Google Chrome, Microsoft
Edge e Mozilla Firefox.

RPA Workspace v.27 release
Review what's new and changed, and the fixes and limitations in RPA Workspace for the v.27 release.

Novità

Control Room, devices, and Bot Agent

Windows 365 Cloud PC now supported as Bot Runner (Service Cloud case ID: 01792699)
We support Windows 365 Cloud PC as a Bot Runner to create and run bots on Windows 365 Cloud
PC.
Automation 360 Bot Runner device requirements alla pagina 829

Oracle Database is now supported on Linux (Service Cloud case ID: 00726728)
We now support Control Room with Oracle Database on Linux, so you can now choose to install the
Control Room with Oracle Database on Linux.
Installing Control Room on Linux alla pagina 948 | Database requirements alla pagina 845

Microsoft Edge offline extension is supported (Service Cloud case ID: 01829649, 01880289)
You can now install the Microsoft Edge offline extension for Microsoft Edge Enterprise browser users
even when the device is offline.
When the Bot Runner machines do not have Internet connectivity, you can use these features with
the Microsoft Edge offline extension:
• Automation of web apps
• User interface triggers
• Device registration

The Microsoft Edge offline extension is transparent and works similarly to the Microsoft Edge online
extension for users.
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039 | Browser extensions for
Automation 360 alla pagina 718
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Control Room, devices, and Bot Agent

Centralized notifications repository for various events and capability updates
You can now track all the platform and automation events through a centralized repository. With
this feature, you can identify the severity of events, consider possible actions based on the severity
of events, and then take appropriate actions. You can also be notified about platform updates, such
as bot export and package updates. Thus, it improves platform and user productivity.
Notifiche alla pagina 2913

Automatically select the number of Bot Runners (Service Cloud case ID: 00821020,
00715598, 00723191, 00784822, 01830238, 01870817)
You can enable Automation 360 to automatically select the Bot Runner users for specific tasks to:
• Scale automations easily
• Run bots concurrently
• Use resources efficiently

This capability ensures that when you run or schedule an automation, the system automatically
picks the available run-as users from the specified list.
Automatically select the number of Bot Runners users alla pagina 2623 | Programmare un bot alla pagina
2616

Manage domain accounts using gMSA (Service Cloud case ID: 00731119)
You can use a group Managed Service Account (gMSA) to manage and run Control Room and other
Automation 360 services.
Configura credenziali di servizio alla pagina 910

View keyboard shortcuts in Bot editor
In Bot editor, you can now open a menu to view the available keyboard shortcuts.
Keyboard shortcuts alla pagina 2019

Validate device credentials prior to bot deployment
Prior to bot deployment, you can select to validate the device credentials for Bot Creator, attended
Bot Runner, Citizen Developer, and unattended Bot Runner users. This provides users additional
security for bot deployment.
Commutare la registrazione del dispositivo tra istanze di Control Room alla pagina 2734

Export roles to view users and their permissions (Service Cloud case ID: 01804955)
You can export selected roles and their permissions to CSV files to view the following information:
• User information
• Run-as user information
• User permissions
• Folder permissions

Export roles alla pagina 2715
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Control Room, devices, and Bot Agent

TLS 1.3 encryption support for a more secure connection to Control Room services
(Service Cloud case ID: 00549240, 00606859, 01925085)
Automation 360 On-Premises supports both TLS 1.3 and TLS 1.2 cryptographic protocols for HTTPS
and TCP communications between our components.
Support for secure protocols alla pagina 40 | Configure application Transport Layer Security alla pagina
907

Enhanced Automation Anywhere Debugger tool
The Automation Anywhere Debugger tool is available in the Bot Assistant utility to provide a
better user experience. When you invoke the Debugger tool from the Bot editor, you can add,
update, or delete actions and variables in a bot.
By default, the Watched variables lists is empty. With a single click, you can add all the used
variables in a bot. These variables display in a pop-up window where you can select or deselect,
one or more variables, from the list.
Debugger tool

Google Chrome and Microsoft Edge certification for operating systems
Google Chrome and Microsoft Edge extensions are certified for the following operating systems:
• Microsoft Windows Server 2012 Standard R2
• Microsoft Windows Server 2016
• Microsoft Windows Server 2019

Packages, actions e Bot editor

Notification for package updates
When you add or update a package or upload a custom package to the Control Room, you are
now notified about this platform event. This notification is displayed to all the Control Room users
through the Notifications repository.
Capabilities supporting notifications alla pagina 2925 | Add packages to the Control Room alla pagina
2649 | Add custom package to your Control Room alla pagina 2434 | Upload custom package to your
Control Room alla pagina 2374

ServiceNow package
You can use the ServiceNow package from Automation 360 to authenticate and perform several
actions with records and attachments in ServiceNow tables.
ServiceNow package alla pagina 1845

ServiceNow triggers
You can use ServiceNow triggers to call an action when there is a new or updated record.
ServiceNow New Record trigger alla pagina 2216
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Packages, actions e Bot editor

Cut, copy, paste keyboard shortcuts added for TN3270 and TN5250 Terminal Emulator
In the Terminal Emulator package, the following keyboard shortcuts are now available specifically
for TN3270 and TN5250:
• Shift + Control + A = Select all
• Shift + Control + C = Copy
• Shift + Control + X = Cut
• Shift + Control + V = Paste

Using Send text action alla pagina 1911

Quick assistance at hand for the developers in the Bot editor
The accessibility and usability of the Bot editor, actions, and packages have been improved. As
a citizen developer or an RPA developer, when you are creating bots, you can quickly look up
information about the actions without navigating outside the Bot editor. Under the Actions pane,
quick help is enabled with contextual information about actions. Additionally, an icon is configured
with a link to the documentation. If you want more information about an action, you can click the
link, which redirects you to the relevant page in the documentation portal. This feature is currently
available in the following actions and packages.
• Database
• Email

Enhanced user experience through refreshed and intuitive icons
With the new and intuitive icons for actions in the Bot editor, citizen developers and RPA developers
can quickly locate the correct action while creating automation for a day-to-day task. These unique
and renewed icons are developed according to brand and global standards.

Seamless package updates
When a package version is added to the Control Room, either from a Cloud download or Control
Room upgrade, as an administrator, you have the flexibility to disable the new version of packages.
This feature helps you to restrict users from using the new package version until it is verified.
Package updates alla pagina 2724 | Aggiornamenti automatici del package per On-Premises Control Room
alla pagina 2726 | Automatic package updates for Cloud Control Room alla pagina 2727

New option in Read from action of Database package (Service Cloud case ID: 01263940)
A new check box is available when you use the Read from action to retrieve records from the
database and save the retrieved data in a CSV file. When you select this check box, no CSV file is
created if the executed SQL query does not return any data.

Proxy support for EWS-OAuth2 (Service Cloud case ID: 00771400, 01574715, 01815888)
When you create a bot with the Email package that uses EWS OAuth2 for authentication and
the Bot Runner machine is configured behind the firewall, then all outbound requests are routed
through the proxy server configured on the Bot Runner machine.
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Packages, actions e Bot editor

64-bit ODBC driver now supported in Database package (Service Cloud case ID: 01256142,
01829360, 01849908)
We now support connecting to databases by using the 64-bit ODBC driver. This option is available
when the connection mode is the default. Organizations transitioning to Office 365 will benefit from
leveraging this enhancement and can sustain automation build with 32-bit ODBC drivers.
Utilizzo dell'action Connetti per il database alla pagina 1451

OAuth 2.0 support in Email and Email trigger packages (Service Cloud case ID: 01798311,
01803702, 01791859, 01828526)
Microsoft is deprecating the ability to use Basic authentication in Exchange Online for these specific
protocols:
• IMAP
• POP3
• EWS

We support OAuth 2.0 authentication for these protocols in the Email and Email trigger packages.
For enhanced security, you can maintain the business continuity of your email automations by
switching the authentication type from Basic to OAuth 2.0, (as recommended by Microsoft).
Using Connect action for Email alla pagina 1497

Retry mechanism supported in credential variables (Service Cloud case ID: 01786319,
01887182)
The credential variables support the retry mechanism. When you create a bot that uses credential
variables, if the bot fails during run time to retrieve those variables from the Credential Vault
because the Control Room is disconnected or the Control Room services stop intermittently, then
the bot tries three times to retrieve the credential variables from the Credential Vault.

Nota:  Ensure that the Bot Agent version installed on your system is the version that is released
with Automation 360 v.27.
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Packages, actions e Bot editor

Support of other domain name in the Active Directory package (Service Cloud case ID:
01807358, 01910765)
We now support Active Directory user operations by logon name with domain and can provide the
domain name to extract user details. When you retrieve the user property or perform any user
operation based on the logon name (userPrincipalName), and if the user domain name differs from
the domain specified in the LDAP path, the user properties are now successfully retrieved with or
without a domain name.
For example, LDAP Path: LDAP://ADServer/DC=automation, DC=net

Utente Gruppo di accesso

userPrincipalName: kim@aaengg.net User can provide logon name as
kim@aaengg.net.

userPrincipalName: shaun@aasales.net User can provide logon name as
shaun@aasales.net.

userPrincipalName:sarah@automation.net user can provide a logon name as either sarah
or sarah@automation.net.

The following list of actions supports logon name with domain.
• Aggiorna dettagli utente
• Rinomina utente
• Elimina utente
• Attiva account utente
• Disattiva account utente
• Imposta proprietà utente
• Ottieni proprietà utente

User account operations alla pagina 1386

Shared mailbox support for Email automation (Service Cloud case ID: 00797231, 01816574,
01829499, 01854615, 01871861, 01933058, 01834152, 01829684, 01853949, 01880386,
01869636, 01894591, 01867553, 01911371. 01925438)
The Email package supports the email automation of a shared mailbox in Outlook for Office 365/
Microsoft 365 using IMAP/EWS protocols, and OAuth 2.0 authentication using Client Credentials
and Authorization Code with PKCE grant flows. You can automate emails retrieved from a shared
mailbox and perform all email-related tasks by accessing each folder(s) and its subfolder(s) in the
shared mailbox.

Nuova action nel package Text file
You can use the new Read variables action in the Text file package to read the values of variables
from the text file.

Nota:  The Import string from text file action in the String package has been deprecated and
will not be available for new bots. We recommend that you use the new Read variables action
with enhanced capabilities. This deprecation does not impact any existing bots or bots which were
migrated previously and they will continue to run properly. See Support and deprecation policy for
packages alla pagina 744 for package lifecycle and deprecation policy.

Read variables action alla pagina 1916

© 2023 Automation Anywhere. All rights reserved.     105



    Automation Anywhere - Learn

Packages, actions e Bot editor

Call an existing JavaScript function in a webpage
You can use the new Call a JavaScript function action in the Browser package to call an existing
JavaScript function directly in a webpage or in an iFrame within a webpage in Google Chrome
and Chromium-based Microsoft Edge browsers. In the bot, you can also pass one or more input
parameters to the JavaScript function and process the return value from the function.
Call a JavaScript function action alla pagina 1426

Automate controls using Microsoft UI Automation (COM) technology
You can use the Microsoft UI Automation (COM) technology to automate the following scenarios:
• Capture and automate client controls
• Capture and automate password text controls
• Capture and automate page tab controls

Actions performed on objects captured with Universal Recorder alla pagina 1755 | Capture using specific
technology alla pagina 1770

Capture objects on applications running in administrator mode
You can use the Recorder to capture objects on applications running in administrator mode. To
capture the object, select the Capture and run with admin privileges option from the Bot
editor.
Pacchetto Recorder alla pagina 1751

Enhanced bot performance when using global values across bots
When you use global values across a parent bot and a child bot, the bot performance is enhanced
by reducing the bot execution time. To enable enhanced bot performance, you must set the Bot
compatibility version to 3 in the Advanced settings page of the Bot editor.

Nota:  Ensure that the Bot Agent version installed on your system is the version that is released
with Automation 360 v.27.

Versione di compatibilità di Bot alla pagina 2016

Enhanced user interface for Define functionality in AISense Recorder
• We have enhanced the user interface of Define window in the AISense Recorder that enables

you to use anchors easily and automate UI objects that are not detected by AISense Recorder
automatically. To improve functional clarity, the following object types are renamed:
• Active text is renamed to Link
• Passive text is renamed to Text value

• If you unintentionally click the screen or click before the highlighter appears, the AISense
Recorder provides visibility into it. You must confirm to capture the object again or use the
Define functionality to define the object on the screen.

• In the Define window, the AISense Recorder shows embedded help for each of the control
types so you can select the correct control types for custom objects.

Use variable anchor alla pagina 1984 | Capture Textbox, Radio, Checkbox, and Combobox alla pagina
1978 | Capture text value through AISense Recorder alla pagina 1976 | Capture link button through
AISense Recorder alla pagina 1975 | Capture Image button through AISense Recorder alla pagina 1973
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Packages, actions e Bot editor

New virtual key added to the Simulate keystrokes package
In the Simulate Keystrokes > Keystrokes action, a new key named Return has been added
to the virtual keyboard for Enter functionality and the Enter key in the Number pad has been
renamed to Num Enter. As a result, the Return key is the main Enter key on the keyboard. This
enhancement keeps the keyboard in sync with the physical keyboard. The nomenclature has been
changed to avoid confusion between the Enter key on the keyboard and the Enter key on the
Number pad.

Support for global variable for all Datetime actions
In the Datetime package, you can use the Datetime global variable across all Datetime actions.
You can select to use either String variable or a Global variable in the Source date and time
variable option. This avoids creating multiple local variables and reduces the total number of
actions used in a bot.
Datetime package alla pagina 1471

The resiliency of the File/Folder trigger has been improved to continue listening after a network
disruption has occurred. Previously, a network error caused the trigger to lose connection with the
Bot Agent.
Service Cloud case ID: 01769532, 01773584, 01834098, 01867418

Importante:  For information about the supported packages for this release, see Packages updated in v.27
alla pagina 129.

Building and running bots

Notification for bot export
When you export a bot in the Control Room, you are now informed through the Notifications
repository. This notification is sent only to the user who exported the bot.
Capabilities supporting notifications alla pagina 2925 | Esporta bots alla pagina 2835

Code analysis runs automatically for all unscanned bots in public workspace
Code analysis now runs automatically on all the bots with the Not Scanned status in the public
workspace. This ensures visibility on the coding best practices for policies configured in the Control
Room and will show the results of code analysis for all the bots in the public workspace without the
need to run code analysis on each bot one by one.

Check out multiple bots and files (Service Cloud case ID: 00628344, 00822352)
You can now select multiple bots and their dependent files from different folders that belong to the
same process and check them out from the public to the private workspace. You can check out a
maximum of 10 parent bots, but there is no limitation on the number of dependent child bots.
Check out multiple bots alla pagina 2001
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Building and running bots

Choose specific version of non-bot dependency to check out with parent bot
When you check out a parent bot, you can now choose the version of a non-bot file dependency to
check out. Every version of a parent bot can have different versions of non-bot file dependencies.
With this feature, you can roll back the dependencies while rolling back the parent bot. You can
make changes to a specific version of the dependent non-bot file.
Check out non-bot file dependencies alla pagina 2048

Compare bot version in private workspace (Service Cloud case ID: 01761840, 01771389,
01763432, 01904500, 00798356, 01780116)
You can now see the changes made to your bot logic in the private workspace before checking in
your bot. As a Bot Creator, it was difficult to identify the changes made to the bot logic, input, and
output parameters. With this functionality, you can now easily identify where you have made the
modifications to the bot logic, variables, triggers, dependencies, and packages compared to the
latest version or any other previous version of the bot.
Compare bot versions alla pagina 2007

Edit non-empty folder description in public workspace (Service Cloud case ID: 01820406)
You can edit the description of non-empty folders in the public workspace. Meaningful descriptions
provide more insight of the bots contained in that folder. This feature enables an administrator
or a user with rename folder permissions to better manage the repository when it contains many
folders.
Crea e rinomina le cartelle alla pagina 2018

Specify queue running times in workload automations (Service Cloud case ID: 01816260,
00331357, 01924895, 01274769)
You can set the specific time period when to run a workload automation. When creating the
workload automation, you can set the queue running days and time to ensure that the automation
does not run during these scenarios:
• Applications are not available
• During scheduled upgrades
• Non-working days (holidays, weekends)

Esegui bot con coda alla pagina 2807

Check for duplicates when adding work items (Service Cloud case ID: 00825850, 01792046,
01806516)
You can check for duplicate work items before adding them to the queue. This feature prevents
re-processing the same work items multiple times, thus saving time and resources. You can either
move the work items marked as duplicate for re-processing or discard them.
Insert Work Items alla pagina 2805

Generation of API Key is audited
The generation of the API key is now audited and will display the expiry time of the api-key in the
audit logs.
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APIs and integrations

Workato Integration
You can integrate the Automation 360 platform and Workato by using the Automation Anywhere
connector. You can establish a connection with the Automation Anywhere Control Room and
perform various operations using the Control Room APIs.
Workato integration

SnapLogic Integration
You can now integrate the Automation 360 platform and SnapLogic. You can establish a connection
with the Automation Anywhere Control Room and perform various operations by using the Control
Room APIs.
Snaplogic integration

Bot RPA per Salesforce

Now when creating new connections, you have the option to include an API Gateway certificate.

Cosa è cambiato

Control Room, devices, and Bot Agent

Automated reprocessing of failed WLM work items (Service Cloud case ID: 00825872)
When you create or edit a queue, you can now use the Max auto retry attempt option to ensure
that failed WLM work items are reprocessed automatically. With this option, you can specify the
number of times for which the automatic reprocessing of failed work items will be attempted.
Automatic reprocessing of failed work items is attempted after all the work items in a queue are
processed.

Better device management with improved device permissions (Service Cloud case ID:
01264963, 01871530)
You can now view and manage Bot Agent devices even if you have not registered them by using
the enhanced Edit the device(s) permission. The Edit the device(s) permission is improved as
follows:
• Device(s) from my device pools: To edit devices from device pools
• Run as users default device(s): To edit Run as user(s) default device

The Control Room administrator grants you access to a specific set of devices based on your role.
When the Edit the device(s) permission with the Device(s) from my device pools and Run as
users default device(s) options is selected, you can view and manage all (registered and non-
registered) devices from a specific accessible group.

Enhanced bot Compare versions page
The bot Compare versions page shows changes in the dependencies between two versions of
the bot. It shows changes for the first level of dependencies only and displays those dependencies
sorted in alphabetical order.
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Control Room, devices, and Bot Agent

Specify time period to put work item on hold (Service Cloud case ID: 00825875)
You can put a work item on hold for a specific date and time. This ensures that the work item
moves automatically to processing (new state) on the specified date and time and no longer
requires you to manually move it for re-processing. A new column in the Edit queue page displays
the hold status of the work item, either date and time or indefinite if you do not specify the date
and time.
Modifica code alla pagina 2813

Packages, actions e Bot editor

Control Room version compatibility check with specific packages
When you manually upload a package or a bot in the Control Room, the system now checks if the
specific packages used in the bot are compatible with the Control Room version.

Analyze button renamed in Bot editor
The analyze button of Bot Insight (Analyze Task Bot) has been renamed to Bot Insight
"Analyze" dashboard in the Bot editor page.

Correzioni

Build 16701: This build includes the following fixes (along with fixes from the previous builds):

Fix for inconsistencies that were observed on the In-progress activity page.
Service Cloud case ID: 01949323, 01950696, 01944637, 01951100, 01953055, 01950639,
01951722

Build 16694: This build includes the following fixes (along with fixes from the previous builds):

If the Manage my activity feature is enabled for a user role, then the user can view the pause,
resume, and stop status on the In progress activity page. If this feature is disabled, then the
user cannot view these statuses.
Previously, users were able to view these statuses even when the feature was disabled.
Service Cloud case ID: 01937106

Build 16667: This build includes the following fixes:

When synching with the Active Directory (AD), the user mapping no longer overwrites the
Description field in the Control Room with blanks.

The Automation 360 Control Room no longer generates an error in the User Management log when
a mapped security group has no members.
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The In progress activity page no longer shows bots after they are run.
Previously, the page incorrectly showed bots in the active state even after execution.
Service Cloud case ID:

01914651, 01924866, 01923265, 01928088, 1918956, 01922321, 01931985, 01921849, 01938985,
01939812,
01940084, 01940585, 01940258, 01938868, 01934451, 01940222, 01941187, 01940900,
01941742, 01939639,
01941503, 01941496, 01939639, 01942720, 01942430, 01943379, 01943617, 01938885

When a user is assigned an admin role to create schedules and later the admin access is removed
for that user, an audit log will be logged when the schedule is canceled because of the user not
having the admin privileges.
Previously, when such schedules were canceled, no audit logs were logged indicating that the
schedule was canceled because the user did not have the required privileges.
Service Cloud case ID: 01830359

The Administration > Licenses page and the Control Room banner displayed on the same
licenses page now display correct information about license expiry.
Previously, the correct information about license expiry was not displayed.
Service Cloud case ID: 01807324

When you edit a role, the Edit role audit log page now displays the correct old, new, and run-as
user values.
Previously, these values were not displayed.
Service Cloud case ID: 01759116

When you edit your first or last name on the My profile page, the description and auto login
values on the Edit user audit log page will not be updated.
Service Cloud case ID: 01846878

You can correctly filter the status for activities on the Activity > Historical page.
Previously, some filters were not displaying the correct status for activities.
Service Cloud case ID: 01869361, 01875216

Users without permission cannot view the activities of other users on the In progress activity
page.
Previously, some users were able to view the activities of other users even though they did not
have permission.
Service Cloud case ID: 01911289, 01910582

If you configured the log collection level as Debug, the logs collected from some packages do not
include customer data.
Previously, the logs collected from some packages included customer data.
Service Cloud case ID: 01862053, 01870001
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If the CPU utilization and device memory threshold values are outside the percentage range defined
by the Control Room administrator in the Administration > Settings > Devices > Threshold
settings for multi-user devices, a clear error message now indicates the device unavailability
and provides an appropriate action.
Previously, when the CPU utilization and device memory thresholds values exceeded the defined
value, bot deployment failed with an unknown error message.

Device shows an accurate status when the Bot Agent is disconnected from the Control Room.
Previously, due to the default time (15 minutes) of the WebSocket connection, a device was shown
as connected even when the Bot Agent was disconnected from the Control Room.
Service Cloud case ID: 01843990

In the Oracle Database environment, a checked-in bot is now automatically refreshed and can be
viewed in the Public folder.
Previously, to view a checked-in bot in the Public folder, you had to manually refresh the
Automation page by using the Refresh button.

When a Stop Task command is used, WLM work items are now marked as completed successfully
and show the correct status in the Control Room.
Previously, WLM work items were marked as failed even if the bot was executed successfully.
Service Cloud case ID: 01841320, 01840748

When you run WLM automations, if the Control Room restarts during deployment, the WLM
deployment continues without delay when Control Room services are active.
Previously, after the Control Room restarted, there was a delay of 15 minutes before the WLM
deployment continued.

When you run a bot by using the Run bot with queue option, the correct value of the work item
is now selected, irrespective of the modification source. Previously, when the value of a work item
was modified through the API or bot setting, the older value was selected by the bot
Service Cloud case ID: 01786785

In an Oracle Database environment, when you select the number format and sort order for the
work items in a queue and then run bot by using the Run bot with queue option, the queues are
now deployed successfully. Also, the correct log entry is shown in the Audit log or Activity page.
Previously, queues were not deployed, and no errors were shown in the Audit log or Activity
page.

In a clustered environment, the bot deployment progress is no longer stuck and the Bot Runner
device connects to the Control Room successfully.
Previously, the bot deployment progress would get stuck sometimes and show an error message
Waiting for user: <username> and/or device: <device-name> on the In progress
> In progress activity page.
Service Cloud case ID: 01830285

When a bot keeps running for a few hours, an error no longer occurs due to high memory usage
with the Recorder package version 2.9.2 or later.
Previously, an increase in memory usage caused the bot to fail after a few hours with a Java heap
space error.
Service Cloud case ID: 01911565
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When you read emails within a loop using a Microsoft Outlook Client connection with a subject filter,
use the Delete action and run the bot, the bot now completes the set iteration and deletes the
emails from the specified folder. Additionally, the variable that was used to display the count of total
emails versus deleted emails now displays the correct counts in the message box.
Service Cloud case ID: 01845642,01857791,01880424

When you establish a connection with the EWS server, and emails are read within a loop to filter
and move all emails from a subfolder created within the custom folder, the bot now executes
without an error.
Previously, an error occurred because the bot could not read the emails from the folders created
outside the predefined folder, such as Inbox, Junk, or Draft.
Service Cloud case ID: 01823238

You can now successfully create a bot by using the Upload file action from the Office 365
OneDrive package.
Previously, the bot displayed an error when you used the Upload file action and if the file name
had special characters such as brackets [].

Nota:  Brackets [] are now supported in the file name.

Service Cloud case ID: 01798568

When you choose the variable option to perform a task and during bot creation process you delete
the variable you created (Your variables), and when you click the Add option in the variable field to
insert a variable (such as global variable), the option is now enabled.
Previously, the Add option for inserting the variable was disabled.
Service Cloud case ID: 01869139

When you create a bot, you can now use the Update node action of the XML package to update
the value of a node. Previously, the attributes were removed when you updated the text value of an
XML element.
Service Cloud case ID: 01805643

In the Email package, connect to the EWS server and use Loop > For each mail in mail box. If
the source mail is sent on behalf of some other user, for example, user xyz@aa.com sent mail on
behalf of user abc@aa.com, the email dictionary variable emailFrom now returns the correct sender
ID, which is abc@aa.com.
Previously, the email dictionary variable emailFrom returned the sender ID as xyz@aa.com.
Service Cloud case ID: 01856149

When you run a stored procedure in Oracle and it returns SYS_REFCURSOR, the Run stored
procedure action closes the cursors.
Previously, the Run stored procedure action was not closing the cursor after the maximum cursor
limit was reached.
Service Cloud case ID: 01842046, 01898572
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In the Active Directory package, when you perform a user account operation such as Add users
to group, Delete user, Disable user account, or Rename user, and if the username has an
asterisk (*), open parenthesis, or close parenthesis, you can now add a user without any error.
Previously, the username did not support the following special characters: asterisk (*), open
parenthesis, and close parentheses.
Service Cloud case ID: 01884962

When you create a folder in Outlook with a percentage (%) in its name (for example, Clients
%ClientA), create a bot using the Connect action from the Email package and then use the
Folder exists or Folder does not exist condition, the bot finds the Clients%ClientA and
retrieves mail from it.
Previously, the bot was not able to retrieve mails from the folder because percentage (%) was not
supported in the folder name.

When you connect to the Microsoft Access Database with JDBC and specify the database path, if
you use the following specific aggregation functions in the query, an error is no longer encountered
when you run the bot:

ASC, ATN, SQR, CBOOL, CCUR, CDATE,
CDBL, CDEC, CDATE, CDBL, CINT, CLONG, CLNG,
CSIGN, CSTR, CVAR, DATEADD, DATEDIFF, DATEPART,
DATESERIAL, DATEVALUE, FORMAT, IIF, INSTR, INSTRREV,
ISDATE, IsNull, ISNUMERIC, LEFT, LEFTS, LEN, MID,
MONTHNAME, DATE, NOW, NZ, SIGN, SPACE, STR, TIME, VAL,
WEEKDAYNAME, WEEKDAY, STRING, TIMESERIAL, CONCAT

When using the Task Bot: Run action, you can search dictionary and session variables to use as
input parameters. Previously, no results displayed when using this Advanced search feature.
Service Cloud case ID: 01879539

A TaskBot no longer fails when you debug or run it when any in_Window input variable is set.
Previously, in edit mode, when you debugged or ran a TaskBot with an input variable by selecting
the Use as input check box, the bot failed.
Service Cloud case ID: 01919263

When you use the Save action in the Email package, and if the email subject includes a comma (,),
the emails are saved successfully.
Previously, if the email subject included a comma (,) and you saved the email, the comma (,) was
replaced with an underscore (_).
Service Cloud case ID: 01786211

When you select the Package details page, and select the Availability tab, if the package (all
users or selected roles) is changed, then the Package details page displays the last modified
information of the user who made the changes, and the changes made at the access level (all users
or selected roles).

You can create bots using the Download file action of the Google Drive package.
Previously, when you used the Download file action and marked the Overwrite existing file
option to overwrite the file of the same name, the downloaded file became corrupted. If you then
used the Excel advanced > Open action to open this file, or manually tried to open the Excel file,
an error message displayed indicating that the Excel file was corrupted.
Service Cloud case ID: 01833815

© 2023 Automation Anywhere. All rights reserved.     114



    Automation Anywhere - Learn

You no longer have an incorrect starting date when you create an event using the Google Calendar
package.
Previously, when you created an event in Google Calendar and entered the value in the Start Date
field with the event type set to All Day, the Google Calendar package decremented the day value
by one when you selected the All Day option.
Service Cloud case ID: 01815644

When you use the Excel advanced > Open action to open an Excel spreadsheet which did not
exist and then run the bot, the bot now displays the correct error message in Japanese.
Service Cloud case ID: 01857992, 01925567

You can successfully extract fields from a PDF file when you use the PDF > Extract field or
Extract text actions.
Service Cloud case ID: 01818304

When you use the 3.6.1-20220428-010115 version of the Simulate keystrokes package to enter
keystrokes against specific webpages running in the Microsoft Edge browser with IE mode, the bot
processes the keystrokes faster.
Service Cloud case ID: 01820418

When you use the PDF > Split document action to split multiple PDFs into various folders and
then use the For each file in folder iterator to run the bot in a loop to split each file in the
specified folder, the bot no longer encounters an error.
Service Cloud case ID: 01803983

When you use the File > Copy Control Room file action and choose the dynamic file path option
to select a file from the Control Room repository, the bot no longer encounters an error. Previously,
even if the uploaded file was available in the Control Room, the bot failed and displayed this error
message: Get Resource failed: Error: Could not find the file at the Control
Room path. Check the file path and try again.
Service Cloud case ID: 01805364

When you use the File > Rename action to rename and overwrite an existing file, the bot no
longer shows an incorrect error message. Previously, when you tried to rename an existing file, the
bot showed an incorrect file name in the error message.
Service Cloud case ID: 01845943, 01858350

You can successfully rename the file and remove an extension from the file name by using the File
> Rename action. Previously, when used the Rename action to remove an extension from the file
name, the bot trimmed the last character from the file name instead.
Service Cloud case ID: 01842995

When you use the Recorder to capture objects on an application that is installed on a virtual
machine, finish the recording after the objects are captured, and then relaunch the Recorder, the
bot successfully launches the Recorder and no longer inserts any actions that were recorded earlier.

When you use the Recorder > Capture action to automate Citrix virtual apps running on Google
Chrome and Microsoft Edge browsers, add a delay of 60 seconds and run the bot, then if the object
does not exist, the bot waits for the specified time (60 seconds) in the Keep trying for (seconds)
field before executing the next steps.
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When you run the bot using the following sequence of actions, the bot shows accurate data for
each loop iteration:
1. Use the Database > Connect action to connect to the database
2. Use the Database > Read action to read the values from the database
3. Use the For each row in a SQL query dataset iterator to run the bot in a loop
4. Use the Database > Disconnect action to disconnect from the database and select the Keep

database schema in cache until bot finishes running option.

Previously, during the second loop iteration, the action picked up data from the previous loop.
Service Cloud case ID: 01817192, 01853717, 01880154, 01940546

An error no longer occurs when you use Recorder package 2.8.6 and later versions to perform a
click operation on a link element that opens a pop-up window on a web page running in Microsoft
Edge with IE mode.
Service Cloud case ID: 01845776, 01858872, 01923003

When you install the AARemoteAgent_2.0, the DLL files are now copied to the correct A360
Remote Agent folder and the AARemoteAgent_2.0 runs properly. Previously when you installed
the AARemoteAgent_2.0, the DLL files were copied to an incorrect A360 Remote Agent\Java
folder.
Service Cloud case ID: 01935630

You can now successfully use the PDF > Extract field action to extract values from a PDF that
contains a string data type with the dollar sign ($).
Service Cloud case ID: 01848220

You can now successfully run all migrated web actions of the Legacy Automation package in
multiple steps of a bot in Microsoft Edge with IE mode.
Service Cloud case ID: 01853563, 01865846

In the File > Copy Desktop file action, when you use a variable that contains a number sign (#)
instead of a file path to locate the file that you want to copy, the bot no longer encounters an error.
Service Cloud case ID: 01808009, 01845923

When exporting data to Excel CSV files, Boolean values return accurately. Previously, a bug caused
values to return as -1 while using OLE DB Driver for SQL Server (version 18 or later).
Service Cloud case ID: 01826530

Updating the Bot Agent version sometimes failed. However, when you select the Automatically
update all bot agents option, the Bot Agent updates to the latest version without failures.

Control Room now supports Windows NT in French.
Service Cloud case ID: 00682337

All DELETE /v1/configurations endpoints are not accessible anymore.
Service Cloud case ID: 01920980

While installing Automation 360 on a three-node cluster, the installer prompts you to enter the
Elasticsearch password for the first node only and replicates this data across the other two nodes.
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Bots that are running for longer duration display correctly on the In progress activity page.
Previously, these bots displayed only after bot updates and were removed after the page refresh.
Service Cloud case ID: 01921149

You can now update Internet Explorer bots created in Automation 360 to Microsoft Edge with
IE mode using the Update Bot wizard even if these bots (or its dependencies) contain a '.' (dot)
character in its name.
Service Cloud case ID: 01809003, 01814904, 01822014, 01858820

If you selected the Log off windows session post bot execution option under Auto-login
settings in the Control Room, data in the resource folder is cleared after the bot run.
Service Cloud case ID: 01795752, 01778828, 01804711,01864871,01923299, 01823515

If you delete a device entry from Manage > Devices in the Control Room, the device registration
properties are removed. This enables you to reregister the device.
Service Cloud case ID: 01808450

You can successfully log in to Automation 360 using Active Directory credentials when the Auto-
login users into Control Room option is enabled, without encountering any issues..
Service Cloud case ID: 01808170, 01826805

The generated Control Room operational log files contain readable characters.
Service Cloud case ID: 01872473

The Repository Management (/v2/repository/files/<file_id>/content) API now returns file contents
only for the files the logged-in user has permission to view. The content of these files cannot be
updated using a different API.
Previously, this Repository Management API returned file contents for the files that the logged-in
user did not have permission to view. And the user could update the content of these files.
Service Cloud case ID: 01819101

Bot deployment now resumes and completes without any issue when the Task Bot > Pause
action executes before or while the runtime window is loading.
Previously, the resume option was not displayed in the runtime window, and the bot deployment
was not completed.
Service Cloud case ID: 01835794

You can create a folder within the Bots folder in the public workspace.
Previously, folder creation failed with an error in the public workspace.
Service Cloud case ID: 01257981

You can now successfully compare different versions of your bots and dependencies in both the
public and the private workspaces.
Previously, comparing the bot versions failed with a timeout error.
Service Cloud case ID: 01770115, 01905037
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When you export the user data to a CSV file, it now shows the correct user type and device license
information for all users.
Previously, user data exported to the CSV file showed incorrect information.
Service Cloud case ID: 01840507

You can now check in a bot successfully to the public workspace.
Previously, the bot check in failed because the audit trial was processed unsuccessfully.
Service Cloud case ID: 01860361

The BLM export is an asynchronous call and when used with the existing API endpoint /v2/blm/
status/{requestId}, there is a delay associated with the API call. Due to this delay, you cannot
retrieve the current status of the export if there is not enough time gap between the export and the
status call. To bypass this limitation, a new API endpoint has been added GET /v2/blm/status/
{requestId}/timeout/{timeout} which introduces a time delay that waits for the export
process to complete and then retrieves the status.
Service Cloud case ID: 01806109

Upgraded Swagger UI and Swagger Editor to version 4.15.5 to fix a security vulnerability.
Service Cloud case ID: 01843148

When you create bots that use the Excel advanced > Select cells/rows/column action and set
the Cell Range with an expression (such as B1:$SampleNumber.Number:toString$), the Bot
editor no longer displays an error and the action now works properly.
Service Cloud case ID: 01941537

When you use the File trigger to modify a BAT or VBS file, the trigger is generated once. Previously,
the trigger would generate twice when you enabled the file modified scenario.
Service Cloud case ID: 01816589, 01877498

You no longer encounter issues with bot check-in or cancel check-out after the bulk package update
operation. When you try multiple bulk updates of packages, now an appropriate error message
indicates to perform bulk updates of one package at a time.
Previously, when you performed multiple bulk updates of packages, it resulted in check-in or cancel
check-out errors.
Service Cloud case ID: 01849828, 01881950

Bots with a large number of automations complete successfully without any pre-processing issues
or errors.
Service Cloud case ID: 01949415, 01949372, 01949033

Correzioni per la sicurezza

The version of Springframe Work is updated to 5.3.22 and does not exhibit the security
vulnerability. 
Service Cloud case ID: 01850811
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Limitazioni

When you check out bots in bulk, you cannot check out the bots for which you have the required
permissions. This is because bots for which you have the required permissions are also excluded
along with the bots for which you do not have the required permissions.

The bot checkout fails in the following scenarios:
• If a bot with same name (but different case) exists in your private workspace with the same

path.

Nota:  In such cases, the bot checkout or overwrite fails even when an overwrite confirmation
message displays.

• If a folder with the same name exists in your private workspace with the same path.

When you compare bot versions from the View history page in a Public workspace, the
Compare versions page shows an error message.
Soluzione: To fix this error, perform one of the following actions:
• In a Public workspace, click the three dots icon next to the required bot in the Action menu

and click Compare versions.

Nota:  You cannot compare the bot versions when only one bot version is available.

• If you check out a bot to a Private workspace and then modify and save it, click the three dots
icon in the Action menu and click Compare versions.

Service Cloud case ID: 01949094, 01946533

In Windows and Linux operating system, notifications are not working with the Oracle Database.

We use a third-party parser to convert from HTML format to plain text. As a result, when you
convert an email from HTML format to plain text, you will see that, sometimes, the text is not
converted into plain text and is not displayed in the correct format. For example, you might see that
some lines are added or skipped.
Service Cloud case ID: 01822614

In any package, when you select the Add argument option, select String or Number as the
Argument type, and then try to insert a value, you might not be able to navigate through the
options using the scroll functionality.

When you use the System > Get environment variable action to select the list of environment
variables to return the system parameters of the device, some environment variables might not be
visible.

After you upgrade to Automation 360 v.27, if a new package (first version) is added to the Control
Room and in the setting for packages you selected Disable for the new version of package, you
will see that the package will have status as Enabled and set as default instead of Disable.

In an Oracle Database environment, when you upgrade to Automation 360 v.27, the new package
versions that are shipped through the installer remain in the disabled state and are not set as the
default version.
Soluzione: You must enable each updated or new package manually and set the package as the
default version.
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In the Automation page, column customizations made on the Files and folders are not retained
when you navigate away from that page. For example, if you customize the columns in the private
workspace, move out, and navigate back to the private workspace, the previous customization is
not retained. It returns to the default view.
Similarly, searches and customizations such as filters, sort orders, custom columns, and partially
completed edits are not retained when you navigate away from the page.

Limitazioni rispetto alle versioni precedenti

When you run a bot in the Google Chrome or Microsoft Edge browser, use the If, Loop, or Wait
action, select the webpage from the list of active tabs in the Browser tab, close the browser
window, and then run the bot, the bot might take two minutes to open the webpage in the browser
irrespective of the timeout value mentioned.
Soluzione: Move the If, Loop, or Wait action inside the If block and use the Application is
running condition with same browser application to check whether the browser is running.

You will encounter an error when you run a standard workflow in the SAP BAPI package.
Soluzione: To execute SAP BAPI, use the Run Function call (RFC) with a combination of Create
function, Set or Get field value, Set or Get structure, and Set or Get table actions.
A360 : SAP BAPI functions - Run Standard Workflow - Error while selecting
BAPI_SALESORDER_CHANGE (A-people login required)

When you migrate a bot that contains XML command > Get single node, after migration, the
bot encounters the following error: No node found at XPath while executing the Get
Single node commandWorkaround: If the XPath expression is not starting with (/) , apply
XPath starting with “/“ so that at the time of execution, the modification can be skipped or the
XPath expression can be designed to get the desired result.

When you use the Capture action with the Recorder package (version 2.9.x or earlier) to navigate
to another web page in the Google Chrome browser (version 105.0 or later), and then use another
Capture action to automate objects in the navigated web page, the bot might encounter an error.
Soluzione: Before you use the Recorder > Capture action in the bot, maximize the Google
Chrome window .

When you use the If package, add a specific condition with a variable, then add specific conditions
within a group, save the bot, and if you rename the variable that was used, the name of the
variable might not update for the Group conditions but is only updated for the conditions in the
Condition tab.

Command prompt API allows you to switch the device registration even if the Allow devices
(single user) to be switched to another Control Room without reinstalling bot agent
option is disabled.

When you upgrade from Automation 360 v.25 to a later version, although you enabled code
analysis in the Control Room, the rules set in the policy are not retained after the upgrade.
Soluzione: Before upgrading, we recommend that you keep a note of the rules enabled in
Automation 360 v.25 and then re-enable them after upgrading to a later version.

When you uninstall Automation 360 from the Control Panel, the name of the file is displayed
incorrectly (for example, 3e592.msi) on the User Account Control window.

While running a bot in debug mode, the bot will fail if the variable size gets greater than 3 MB. An
error message appears showing that a variable has exceeded the 3 MB limit.
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Aggiornamenti dell'interfaccia

RPA Workspace

The Max auto retry attempt option is added to reprocess the failed WLM work items
automatically.

Automated reprocessing of failed WLM work items
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RPA Workspace

The drop-down menu in the Bot editor now includes an option to open a menu for keyboard
shortcuts.

Keyboard shortcuts

The Device(s) from my device pools and Run as users default device(s) options are added
in the Edit the device(s) permission to manage registered and non-registered devices.

Better device management with improved device permissions
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RPA Workspace

The gMSA option enables you to manage your domain accounts across multiple

servers.
Manage domain accounts using gMSA
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RPA Workspace

The Custom number of bot runners option allows you to
choose the number of Bot Runners that you want to use to run

bots.
Customize the number of Bot Runners
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RPA Workspace

The Automation Anywhere Debugger tool is now available within the Bot Assistant utility to
provide a better user experience.

Enhanced Automation Anywhere Debugger tool
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RPA Workspace

Updated and intuitive icons for all the actions and contextual help for Database and Email actions.

Enhanced user experience through intuitive icons | Quick assistance at hand for the developers in the Bot
editor
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RPA Workspace

The drop-down menu in the Bot editor now includes the Capture and run with admin
privileges option that enables you to capture objects on applications running in administrator
mode.

Capture objects in admin mode
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Riferimenti correlati
Note sulla versione Automation 360 v.27 alla pagina 97
Process Discovery v.27 release alla pagina 153
Review what's new in Process Discovery for the v.27 release.
AARI v.27 release alla pagina 154
Review what's new and changed, and the fixes and limitations in AARI for the v.27 release.
IQ Bot and Document Automation v.27 release alla pagina 162
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.27 release.
Bot Insight v.27 release alla pagina 170
Review the fixes in Bot Insight for the v.27 release.
Packages updated in v.27 alla pagina 129
Review updates to the packages in Automation 360 v.27, including the compatible Control Room and Bot
Agent versions.
Updating to v.27 release alla pagina 128
Review requirements and support information about updating your Control Room and Bot Agent for the
v.27 release.
Migration updates for v.27 release alla pagina 144
Review what's new, changed, and the fixes and limitations to migrating from Enterprise 11 and 10 versions
to Automation 360 v.27.
Browser extensions for Automation 360 alla pagina 718
Crea automazione dai browser supportati utilizzando le estensioni del browser. Le estensioni sono
aggiornate periodicamente per supportare i miglioramenti e le correzioni delle funzionalità. Pertanto,
assicurati di disporre delle versioni più aggiornate delle estensioni per i browser Google Chrome, Microsoft
Edge e Mozilla Firefox.

Updating to v.27 release
Review requirements and support information about updating your Control Room and Bot Agent for the
v.27 release.

Aggiornamenti Bot Agent

Nota:  Questa versione include un aggiornamento di Bot Agent facoltativo. You can continue to run your
existing bots without updating the Bot Agent. However, if you want to use the new features in Automation
360 v.27, you must update the Bot Agent available with this release.

Per informazioni sull'aggiornamento a questa versione, consulta le seguenti risorse:
• Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina

1043
• Compatibility with release builds alla pagina 1026

Certified Control Room builds for direct update

You can update to the latest version of Automation 360 from the previous three releases (that is, from n−3
releases, where n refers to the latest release).
The following previous releases are certified for update to Automation 360 v.27:
• v26 (Build 15450)

© 2023 Automation Anywhere. All rights reserved.     128



    Automation Anywhere - Learn

• v.25 (Build 15112)
• v.24R2 (Build 13343) and v.24 (Build 12350)

If you are on one of these previous releases, for information about updating, see Aggiornamento
alla versione di Automation 360 più recente alla pagina 1063. If you are not on an n−3 release, update
Automation 360 to one of the n−3 releases before updating to Automation 360 v.27.
Per gli aggiornamenti più recenti delle estensioni di Automation 360 per Google Chrome, Microsoft Edge e
Mozilla Firefox, vedi Browser extensions for Automation 360 alla pagina 718.
Riferimenti correlati
Note sulla versione Automation 360 v.27 alla pagina 97
RPA Workspace v.27 release alla pagina 100
Review what's new and changed, and the fixes and limitations in RPA Workspace for the v.27 release.
Packages updated in v.27 alla pagina 129
Review updates to the packages in Automation 360 v.27, including the compatible Control Room and Bot
Agent versions.

Packages updated in v.27
Review updates to the packages in Automation 360 v.27, including the compatible Control Room and Bot
Agent versions.
The following table lists the updates in the packages for this release:

Nota:  Per informazioni sui pacchetti relativi alle versioni precedenti, vedi i PDF di queste versioni: Versioni
precedentemente rilasciate di Automation 360.

Nome
Package
VersioneAggiornamenti
Package
Versione
Bot
Agent

Versione
Control
Room

AARI
web
7.27.0-20221026-170013Nessuno21.134
or
later

12316
or
later

Active
Directory
3.6.2-20221027-064844• New

feature
• Defect

fix

20.11
or
later

8750
or
later

Analizza2.4.4-20220615-020937Nessuno20.11
or
later

8750
or
later

App
Integration
4.8.0-20220616-123118Nessuno21.88
or
later

10195
or
later

Application3.6.1-20221014-042725Localization
changes
20.11
or
later

8750
or
later
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Nome
Package
VersioneAggiornamenti
Package
Versione
Bot
Agent

Versione
Control
Room

Boolean2.6.4-20220919-050851Internal
renaming
of
an
attribute
(no
impact
to
existing
bots
on
upgrade)

20.11
or
later

8750
or
later

Migrazione
di
Bot

10.3.4-20221020-152650• New
feature
1

• New
feature
2

• New
feature
3

• Defect
fix
1

• Defect
fix
2

• Defect
fix
3

• Defect
fix
4

• Defect
fix
5

21.220
or
later

15224
or
later

Browser3.7.5-20221104-153650New
feature
21.210
or
later

14140
or
later

Clipboard3.5.0-20220923-115005Localization
changes
20.11
or
later

8750
or
later
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Nome
Package
VersioneAggiornamenti
Package
Versione
Bot
Agent

Versione
Control
Room

Comment2.12.0Internal
renaming
of
an
attribute
(no
impact
to
existing
bots
on
upgrade)

20.11
or
later

8750
or
later

Credenziale1.4.0-20220930-120805Enhancement20.11
or
later

8750
or
later

CSV/
TXT
2.10.2-20221025-092104Added
intuitive
package
icon

20.11
or
later

8750
or
later

Database4.10.5-20221119-112148• New
feature
1

• New
feature
2

• Defect
fix
1

• Defect
fix
2

• Defect
fix
3

21.88
or
later

10204
or
later

Data
Table
4.6.0-20220920-155212Internal
renaming
of
an
attribute
(no
impact
to
existing
bots
on
upgrade)

20.11
or
later

8750
or
later
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Nome
Package
VersioneAggiornamenti
Package
Versione
Bot
Agent

Versione
Control
Room

Datetime2.10.3-20220919-051216New
feature
20.11
or
later

8750
or
later

Delay3.6.0-20220926-132853Internal
renaming
of
an
attribute
(no
impact
to
existing
bots
on
upgrade)

20.11
or
later

8750
or
later

Dictionary3.10.0-20220929-153817Defect
fix
20.11
or
later

8750
or
later

DLL6.7.1-20221027-124401New
feature
21.220
or
later

15238
or
later

Document
Extraction
1.0.9-20221223-075522Correzioni21.98
or
later

15345
or
later

Email3.15.2-20221006-075826• New
feature
1

• New
feature
2

• New
feature
3

• Defect
fix
1

• Defect
fix
2

• Defect
fix
3

21.210
or
later

13980
or
later

Trigger
di
e-
mail

2.9.1-20221006-095506New
feature
21.210
or
later

13980
or
later
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Nome
Package
VersioneAggiornamenti
Package
Versione
Bot
Agent

Versione
Control
Room

Error
handler
2.10.0-20220929-040735Internal
renaming
of
an
attribute
(no
impact
to
existing
bots
on
upgrade)

20.11
or
later

8750
or
later

Excel
advanced
6.11.0-20220919-135308Defect
fix
21.112
or
later

11307
or
later

Excel
basic
6.11.0-20220919-135307Added
intuitive
package
icon

21.112
or
later

11307
or
later

File6.5.0-20221003-160340• Defect
fix
1

• Defect
fix
2

• Defect
fix
3

21.98
or
later

10789
or
later

File
e
cartella

1.3.0-20221014-182105Defect
fix
20.11
or
later

8750
or
later

Folder6.5.0-20221003-160340Added
intuitive
package
icon

20.11
or
later

8750
or
later

FTP /
SFTP
2.8.3-20221006-182804Localization
changes
20.11
or
later

8750
or
later

Genesys1.0.4Nessuno21.210
or
later

14199
or
later

Google
Calendar
2.9.1-20221006-143939Defect
fix
20.11
or
later

8750
or
later
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Nome
Package
VersioneAggiornamenti
Package
Versione
Bot
Agent

Versione
Control
Room

Google
Drive
2.10.1-20221006-142241Defect
fix
20.11
or
later

8750
or
later

Google
Document
AI

1.2.0-20220616-091303Fixed
the
vulnerabilities
reported
in
the
security
scan

21.98
or
later

10520
or
later
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Nome
Package
VersioneAggiornamenti
Package
Versione
Bot
Agent

Versione
Control
Room

Google
Sheets
2.10.1-20221006-123001The
error
is
no
longer
displayed
when
you:
• Create

a
sheet
with
the
existing
sheet
name.

• Use
Delete
cell
>
Specific
cell
and
select
the
delete
option
as
Shift
cell
left.

• Open
the
spreadsheet
with
session
2
after
disconnecting
the
session
1.

• An
appropriate
error
message
displays
when
you
disconnect
an
previously
closed
session.

20.11
or
later

8750
or
later
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Nome
Package
VersioneAggiornamenti
Package
Versione
Bot
Agent

Versione
Control
Room

Google
G
Suite

2.8.0-20220416-235104Nessuno20.11
or
later

8750
or
later

Hot
key
1.1.0-20220715-220729NessunoNessunoNessuno

If3.5.0-20220928-201537Internal
renaming
of
an
attribute
(no
impact
to
existing
bots
on
upgrade)

20.11
or
later

8750
or
later

Image
Recognition
3.11.1-20221025-190453Fixed
the
vulnerabilities
reported
in
the
security
scan

21.210
or
later

14100
or
later

Moduli
interattivi
2.27.3-20221014-074409• New

feature
1

• New
feature
2

• New
feature
3

• New
feature
4

• New
feature
5

20.11
or
later

8750
or
later

Interface
trigger
1.5.1-20221122-181213None.20.11
or
later

8750
or
later
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Nome
Package
VersioneAggiornamenti
Package
Versione
Bot
Agent

Versione
Control
Room

IQ
Bot
2.2.5-20221107-102303Fixed
the
vulnerabilities
reported
in
the
security
scan

21.98
or
later

10520
or
later

IQ
Bot
Pre-
processor

2.2.5-20221107-101937Fixed
the
vulnerabilities
reported
in
the
security
scan

21.98
or
later

10520
or
later

JavaScript2.13.0-20220620-094839Nessuno20.11
or
later

8750
or
later

JSON1.2.0-20221003-172422Internal
renaming
of
an
attribute
(no
impact
to
existing
bots
on
upgrade)

21.98
or
later

10520
or
later

Legacy
AISense
2.0.1-20221019-100134Defect
fix
21.220
or
later

15224
or
later

Legacy
Automation
5.6.1-20221027-080331• New

feature
• Defect

fix

21.200
or
later

13279
or
later
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Nome
Package
VersioneAggiornamenti
Package
Versione
Bot
Agent

Versione
Control
Room

List2.9.2-20220919-103920Internal
renaming
of
an
attribute
(no
impact
to
existing
bots
on
upgrade)

20.11
or
later

8750
or
later

Log
To
File

3.5.0-20220416-233918Nessuno20.11
or
later

8750
or
later

Loop3.6.0-20220928-191723Internal
renaming
of
an
attribute
(no
impact
to
existing
bots
on
upgrade)

20.11
or
later

8750
or
later

Message
Box
3.4.0-20220416-233919Nessuno20.11
or
later

8750
or
later

Mouse2.12.4-20221021-043050Fixed
the
vulnerabilities
reported
in
the
security
scan

21.210
or
later

14100
or
later

Number3.6.0-20220928-104414Added
intuitive
package
icon

20.18
or
later

9130
or
later

OCR2.10.0-20220502-204318Nessuno21.118
or
later

8750
or
later
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Nome
Package
VersioneAggiornamenti
Package
Versione
Bot
Agent

Versione
Control
Room

Office
365
Calendar

2.10.1-20221006-064900Added
intuitive
package
icon

20.11
or
later

8750
or
later

Office
365
Excel

2.10.1-20221006-064900Added
intuitive
package
icon

20.11
or
later

8750
or
later

Office
365
OneDrive

2.10.1-20221006-064900Defect
fix
20.11
or
later

8750
or
later

PDF3.7.1-20221012-090203• Defect
fix
1

• Defect
fix
2

21.31or
later
9300
or
later

PGP3.4.0-20220118-154220Nessuno21.88
or
later

10195
or
later

Ping3.4.0-20220416-234250Nessuno20.11
or
later

8750
or
later

Play
Sound
2.6.0-20220421-071315Nessuno20.11
or
later

8750
or
later

Printer2.4.0-20220118-154256Nessuno20.11
or
later

8750
or
later

Trigger
di
processo

1.3.0-20220118-154818Nessuno21.112
or
later

11314
or
later

Process
Discovery
2.1.14-20221024-185703Nessuno21.128
or
later

12247
or
later

Prompt2.6.0-20220118-154257Nessuno20.11
or
later

8750
or
later
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Nome
Package
VersioneAggiornamenti
Package
Versione
Bot
Agent

Versione
Control
Room

Python
Script
2.13.0-20221101-070548Fixed
the
vulnerabilities
reported
in
the
security
scan

20.11
or
later

8750
or
later

Registra1.6.3-20220919-051027Internal
renaming
of
an
attribute
(no
impact
to
existing
bots
on
upgrade)

20.11
or
later

8750
or
later

Recorder2.9.2-20221122-181034• New
feature
1

• New
feature
2

• Defect
fix

21.210
or
later

14068
or
later

REST
Web
Service

3.12.0-20220926-070217Fixed
an
issue
where
different
proxies
were
configured
for
a
URL
using
a
PAC
file.

20.11
or
later

8750
or
later

Salesforce1.0.4-20220921-170743Nessuno21.119
or
later

15422
or
later
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Nome
Package
VersioneAggiornamenti
Package
Versione
Bot
Agent

Versione
Control
Room

SAP3.8.1-20221021-121957Added
intuitive
package
icon

21.88
or
later

10195
or
later

SAP
BAPI
2.7.0-20220424-053247Nessuno21.2
or
later

9249
or
later

Screen2.8.0-20220426-033753Nessuno20.11
or
later

8750
or
later

Servizio4.6.0-20220930-121118Localization
changes
20.11
or
later

8750
or
later

Trigger
di
servizio

1.5.1-20220425-083711Nessuno21.112
or
later

11314
or
later

ServiceNow1.0.3-20221010-154249New
feature
21.230
or
later

16455
or
later

Simulate
keystrokes
4.0.1-20221021-090235• New

feature
• Defect

fix

21.200
or
later

13297
or
later

SNMP2.5.0-20220419-063009Nessuno20.11
or
later

8750
or
later

SOAP
Web
Service

3.13.1-20221025-092212Label
change
(Build
Soap
Request
is
renamed
to
Build
SOAP
request)

21.90
or
later

10227
or
later
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Nome
Package
VersioneAggiornamenti
Package
Versione
Bot
Agent

Versione
Control
Room

Step2.4.0-20220929-044740Internal
renaming
of
an
attribute
(no
impact
to
existing
bots
on
upgrade)

20.11
or
later

8750
or
later

String5.5.2-20221006-094641New
feature
20.18
or
later

9130
or
later

System3.10.0-20220921-062556Internal
renaming
of
an
attribute
(no
impact
to
existing
bots
on
upgrade)

21.88
or
later

10217
or
later

Task
Bot
2.5.0-20221020-114450Updated
the
version
for
botRunTime
and
bot
 API

20.11
or
later

8750
or
later

Terminal
Emulator
4.8.0-20220923-172123New
feature
21.93
or
later

10353
or
later

Text
file
1.4.2-20221004-130231New
feature
20.11
or
later

8750
or
later

Attiva
loop
0.7.0-20220715-220725Nessuno20.11
or
later

8750
or
later

Task
Bot
V11

1.12.1-20220707-062607Defect
fix
20.11
or
later

8750
or
later
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Nome
Package
VersioneAggiornamenti
Package
Versione
Bot
Agent

Versione
Control
Room

VBScript2.16.2-20221020-051711Fixed
the
vulnerabilities
reported
in
the
security
scan

21.210
or
later

14100
or
later

Wait4.7.0-20221003-160840Internal
renaming
of
an
attribute
(no
impact
to
existing
bots
on
upgrade)

20.11
or
later

8750
or
later

Window5.8.0-20220923-081314Added
intuitive
package
icon

20.11
or
later

8750
or
later

Trigger
Window
1.4.0-20220118-154823Nessuno20.11
or
later

11314
or
later

Workload2.10.1-20220512-164301Nessuno20.11
or
later

8750
or
later

XML3.8.2-20221025-092212Defect
fix
20.11
or
later

8750
or
later

*These fixes are minor, internal updates, so they do not include an update or further details on our documentation
site. As these updates relate to improvements in security, resiliency, and efficiency, we recommend that you use the
latest package versions to include these updates in your existing bots.

Riferimenti correlati
Updating to v.27 release alla pagina 128
Review requirements and support information about updating your Control Room and Bot Agent for the
v.27 release.
RPA Workspace v.27 release alla pagina 100
Review what's new and changed, and the fixes and limitations in RPA Workspace for the v.27 release.
Note sulla versione Automation 360 v.27 alla pagina 97
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Migration updates for v.27 release
Review what's new, changed, and the fixes and limitations to migrating from Enterprise 11 and 10 versions
to Automation 360 v.27.

Novità

Enterprise 11 e Enterprise 10

Scan Automation 360 bots that use Basic authentication in Email action
This release introduces an option to use the Bot Scanner to scan all Automation 360 bots and
identifies those that use Basic authentication in the Email package and Email trigger action so that
you do not have to identify them manually.
You can use the Bot Scanner report to analyze the impact to the bots due to the Basic
authentication and the estimated effort required to switch the authentication mode from Basic to
OAuth 2.0.
Per ulteriori informazioni, vedi Scan Automation 360 bots for Email action with Basic authentication usage
alla pagina 803 | Basic authentication scanning messages alla pagina 806

Variabili create automaticamente dopo la migrazione
In the Bot Scanner utility, bots that contain the following non-referenced system variables are no
longer flagged as Action Required or Review Required:
• $Excel Column$
• $Filedata Column$
• $Dataset Column$
• $Table Column$
• $XML Data Node$
• $PDFTitle$
• $PDFSubject$
• $PDFFileName$
• $PDFAuthor$

After migration, the system automatically creates these variables based on the Automation 360
naming convention, and the migrated bots run successfully.

Support for SMTP server type with Send Email command
When you migrate bots with the Send Email command, you can select the Use outgoing Email
server settings option in the Bot Migration Wizard to identify and select the server type for the
Enterprise 11 bots. You can configure required server details using a new SMTP server type option.
Consulta Migrazione dei bots di Enterprise alla pagina 1216.
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Enterprise 11 e Enterprise 10

Improved automated editing ability for legacy bots
When you migrated legacy bots that contained the Log To File command, the Carriage Return and
Line Feed (CRLF) characters were converted to LF characters automatically. In Automation 360, the
text is displayed in a single line with no line feed, whereas in Enterprise 11, the CRLF is added at
the end of each line as a line feed. As a result, you had to add the $String:Newline$ variable to
insert a CRLF in the migrated bot.
The new Convert \n characters to \rn\n Log to File action option in the Bot Migration Wizard
enables you to add a new CRLF automatically to migrated bots and avoid manual edits. Migrated
bots that use the Log To File sub-commands to log files can use the CRLF characters in a string.
Vedi Migrazione dei bots di Enterprise alla pagina 1216
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Enterprise 11 only

Migration enhancement to packages and actions
• When you migrate Enterprise 11 bots with variables whose values are read from a text file, the

system adds the String: Import string from text file subcommand to import the variables
from the text file into a string variable. As a result, extra lines are added in the migrated bots.
The Read variables action has been added in the Text filepackage to address the extra lines.
You can use this action to read the values of all variables in a text file as a single line in a
migrated bot which simplifies the post-migration efforts and reduces the number of lines added
in a migrated bot.
Vedi Read variables action alla pagina 1916

• Microsoft is removing the capability to use Basic authentication in Exchange Online for the
following protocols:
• RPC
• MAPI
• Offline Address Book (OAB)
• Exchange Web Services (EWS)
• POP
• IMAP
• Exchange ActiveSync (EAS)
• PowerShell

For those customers running bot for Email automation that connect to Exchange Online using
the IMAP, POP3, or EWS protocol with Basic authentication, we have added authentication
options to support OAuth2 authentication.
You can migrate Enterprise 11 botswith the authentication type set to the OAuth2 option with
Authorization code with PKCE or Client credentials.

• In the Read from action of the Database package, the following option is introduced: Don’t
create file if no data is found. This option is selected by default for migrated bots with the
Database package, and the migrated bots now follow the same behavior as Enterprise 11. If the
executed SQL query does not return any data, the behavior is as follows:
• If this option is selected, no CSV file is created.
• If this option is not selected, a 0 KB CSV file is created.

Per ulteriori informazioni, consulta Using the Read from action alla pagina 1457.
• Migrated bots support the newly added Return key in the Simulate Keystrokes >

Keystrokes action. These bots will continue to display the Enter key (which has been renamed
to Num Enter) and the newly added Return key.

• Migrated bots support access to the Datetime global variable across all actions in the Datetime
commands.

You can successfully migrate TaskBots that contain references to multiple MetaBots which include
DLLs with same name. The session name of the first DLL is created using the name of the DLL.
When the subsequent DLL with the same name from another MetaBot is migrated, the ID of the
folder in which the DLL resides is used as a session name.
For example: M_DLL_Session-<MetabotFolderId>_<DLLName>.
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Correzioni

If the Enterprise 11 bots used the Send Email command without configuring authentication,
now after migration the Email server host, Email server port, and My server requires
authentication values are set to the appropriate values.
Previously, after migration, these values were set to null variables and authentication failed.
Service Cloud case ID: 01849475

After migration, bots that are using Visual Basic script or JavaScript in the Run Script legacy
automation action and using multiple parameters that include spaces without quotation marks will
now display the correct output after execution.
Previously, such bots were displaying incorrect output.
Service Cloud case ID: 01901882

An error no longer occurs during migration when the Select Query bot runs validation. Previously,
the following error randomly occurred with text drivers.
[Microsoft][ODBC Text Driver] Object invalid or no longer set.

After migrating to Automation 360, if the Application window does not exist for the bots that use
the If, IF/ELSE, or Loop in Windows control, then these bots no longer encounter errors during bot
run.
Service Cloud case ID: 01846262

The Stored Procedure parameters are set correctly with Nvarchar when you migrate bots to
Automation 360.

When a bot that contained the File and Folder loop was migrated to Automation 360, an error was
displayed if the corresponding folder did not exist. You can migrate such bots like the corresponding
legacy bot as the If condition is now added before the File and Folder loop to check if the folder
exists.

You can migrate bots that contain the Substring command from the String package to Automation
360, even if the optional Length attribute is blank.

When you migrate a bot that has $counter variable within a nested loop to Automation 360, the
child loop counter is now set to the parent loop counter and the child loop iteration is processed
correctly.

When you run a Select query inside a Loop package, and you reiterate its result set further, the
resultant Loop now reiterates the latest record as expected.
Service Cloud case ID: 01799961

You can successfully migrate bots that have the Wait for object to exist value option set to 0
seconds in the Object Cloning command.

When you use the Run Logic command with an IF/ELSE condition that uses a Credential
variable, all credential variables migrate successfully.

When you migrate Enterprise 11 bots with string variables that have static values, variable parsing
through legacy expressions is no longer performed. This avoids unnecessary parse expressions from
being added to the migrated bots.
Service Cloud case ID: 01819830
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You can successfully run migrated bots that contain multiple Clipboard variables as an output.
Automation 360 adds the Clipboard:Copy to action after every variable so that migrated bot is
run properly.
Service Cloud case ID: 01815938

When you migrate Enterprise 11 bots that use the Connect action with the Terminal Emulator
command, and if the Hostname field contains a Credential Variable, then the field is mapped
correctly after migration.
Service Cloud case ID: 01861600

When you run migrated bots that contain the Legacy Automation > Manage web controls >
Select Item by Text action, the list that contains variables is now displayed as expected.
Service Cloud case ID: 01782998

You can now change, reallocate, or delete the license of a Bot Runner user in a migrated
Automation 360 Control Room, even if the Bot Runner user had logged in to Enterprise 11 Client at
least once.
Previously, an error was displayed in such cases.
Service Cloud case ID: 01829547

You can run migrated bots successfully on SMTP servers when you include the Send Email
command inside a Loop, and that loop iterates more than 100 times.
Service Cloud case ID: 01792886

Migrated bots do not create duplicate variables when the Error_description variable is case-
sensitive.
Service Cloud case ID: 01861530

You can now successfully migrate audit logs using the audit log export utility on a multi-node setup
from the Enterprise 11 Control Room.
Previously, the audit log export utility displayed an exception error in such cases and the audit logs
could not be migrated.
Service Cloud case ID: 01912835

Limitazioni

In Enterprise 11, if bots were using certain keys (such as: Ctrl, Shift, Caps Lock, Num Lock, and so
on) in the Insert Keystrokes command, the keys were reset when an error was encountered during
the execution of child bots. However; after migration, these keys are not reset when an error is
encountered during the execution of child bots. As a result, different output or behavior might occur
during the execution of the other subsequent child bots or the main bot.
Service Cloud case ID: 00773679
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When you migrate a bot that uses the Send email command and run the bot in Automation 360,
the predefined placeholders in the email body are not replaced with their actual content.
Ad esempio:

Task Name: <taskname>
Repeat: <repeat>
Status: <status>
Last Run Time: <lastruntime>

Whereas when you run the bot in Enterprise 11 with these placeholders, the following output is
generated:

Task Name: PLACEHOLDER_SEND.atmx
Repeat: Do not Repeat
Status: Failed
Last Run Time: 11/29/2022 13:04:22

Service Cloud case ID: 01908010

When you run a migrated bot with an XML package that contains an Xpath expression, the running
bot might fail and generate this error message: No node found at XPath
This issue might occur for these specific scenarios:
• If the root element does not have a namespace, and the child element of the XML package has

a default namespace.
• If there are more than one xmlns (the default XML namespace) defined in the XML document.

Service Cloud case ID: 01874203, 01798339
Vedi XML path is not working which works fine in Enterprise 11

Aggiornamenti dell'interfaccia

© 2023 Automation Anywhere. All rights reserved.     149

https://https://apeople.automationanywhere.com/s/article/A360MIG-XML-xpath-is-not-working-which-works-fine-in-v11/s/article/Error-parsing-the-SQL-Instance-name-while-upgrading


    Automation Anywhere - Learn

Migrazione

The Bots using Email action with Basic authentication option is added to the
Bot Scanner to scan bots that use basic authentication in the Email package and Email

trigger.
Scan Automation 360 bots that use Basic authentication in Email action
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Migrazione

The Use outgoing Email server settings option is added to the
Bot Migration Wizard to specify the type of email server you use.

Support for SMTP server type with Send Email command
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Migrazione

The Convert \n characters to \rn\n Log to File action option is
added to the Bot Migration Wizard to provide you an option to not have to
edit the bots manually and a new line is added automatically in migrated

bots.
Improved automated editing ability for legacy bots

Riferimenti correlati
Note sulla versione Automation 360 v.27 alla pagina 97
RPA Workspace v.27 release alla pagina 100
Review what's new and changed, and the fixes and limitations in RPA Workspace for the v.27 release.
Updating to v.27 release alla pagina 128
Review requirements and support information about updating your Control Room and Bot Agent for the
v.27 release.

Remote agent v.2.1.0 updates
A new version of the Remote agent is released with Automation 360v.27. This section includes the fixes for
Remote agent version 2.1.0.
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Correzioni

When a bot keeps running for a few hours, an error no longer occurs due to high memory usage
with the Recorder package version 2.9.2 or later.
Previously, an increase in memory usage caused the bot to fail after a few hours with a Java heap
space error.
Service Cloud case ID: 01911565

An error no longer occurs when you use Recorder package 2.8.6 and later versions to perform a
click operation on a link element that opens a pop-up window on a web page running in Microsoft
Edge with IE mode.
Service Cloud case ID: 01845776, 01858872, 01923003

When you install the AARemoteAgent_2.0, the DLL files are now copied to the correct A360
Remote Agent folder and the AARemoteAgent_2.0 runs properly. Previously when you installed
the AARemoteAgent_2.0, the DLL files were copied to an incorrect A360 Remote Agent\Java
folder.
Service Cloud case ID: 01935630

In the Recorder package, you can now use the Left click, Right click, and Set Text with delay
actions for cross-domain IFrames to automate web pages on Google Chrome and Microsoft Edge
browsers with Manifest V3 extensions. Previously, these actions were not working for cross-domain
IFrames with Manifest V3 extensions.

In the Recorder package, you can now use the Click action for the Link and Form tag controls that
have inline scripting with JavaScript using Manifest V3 extensions.

When you use the Recorder > Capture action to automate Citrix virtual apps running on Google
Chrome and Microsoft Edge browsers, add a delay of 60 seconds and run the bot, then if the object
does not exist, the bot waits for the specified time (60 seconds) in the Keep trying for (seconds)
field before executing the next steps.

Process Discovery v.27 release
Review what's new in Process Discovery for the v.27 release.

Novità

PEG Serverless
With support of up to 100 simultaneous sensors, businesses can easily redact sensitive data
at scale before the data is sent to the Process Discovery platform. Businesses can run Process
Discovery data collection across multiple teams simultaneously, while still providing one interface
for IT Admins to manage the configuration, and one interface for the business to review the
redactions.
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PEG Configuration UI
IT Admins can easily manage forwarding configurations, redaction configurations, and export logs
from a web UI instead of having to run commands on the command line.
Manage redaction and forwarding settings from the UI alla pagina 2316

Correzioni

Discovery Bot admins can now view all created processes without having the Discovery Bot recorder
license.
Previously, if a Discovery Bot admin did not have a Discovery Bot recorder license and was using
version A360.24, A360.25, or A360.26, all created processes did not display on the Processes page.
Service Cloud case ID: 01859123, 01877311, 01860901

Riferimenti correlati
Note sulla versione Automation 360 v.27 alla pagina 97
RPA Workspace v.27 release alla pagina 100
Review what's new and changed, and the fixes and limitations in RPA Workspace for the v.27 release.
AARI v.27 release alla pagina 154
Review what's new and changed, and the fixes and limitations in AARI for the v.27 release.
IQ Bot and Document Automation v.27 release alla pagina 162
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.27 release.
Bot Insight v.27 release alla pagina 170
Review the fixes in Bot Insight for the v.27 release.
Packages updated in v.27 alla pagina 129
Review updates to the packages in Automation 360 v.27, including the compatible Control Room and Bot
Agent versions.

AARI v.27 release
Review what's new and changed, and the fixes and limitations in AARI for the v.27 release.

Novità

Smart embedded forms and dynamic data mapping for embedded widgets
You can now design your forms using a responsive and real-time canvas that can automatically
adjust to the desired form size. This enables a faster way for you to create an embedded interface
for use in any web application. You can also use these forms in your business applications to
securely retrieve data when embedded as an iFrame widget.
To save time and eliminate data re-entry, you can use the postMessage API to map and pre-
populate data from business applications in embedded widgets. Dynamic data mapping provides a
safe and secure communication from your business (host) applications to the initial process forms in
the widget.
Smart embedded forms and dynamic data mapping alla pagina 2237
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Build forms easily by dragging elements to form builder
You can now build your forms by just dragging your elements to a blank form builder. As you add
elements to the form builder, it automatically adjusts without your input, letting you focus on the
form-building experience. You can also re-size the columns of your elements.
Create a form alla pagina 2186

Map data in host web applications for AARI Integrations
You can now map your host applications data to your AARI forms so that when you create a
request, the initial form field will be automatically populated with the mapped data.
Map host data to process alla pagina 2238

URL parameters support for iFrame widget
You can use URL parameters to pass data types (date, time, number, and text box) through query
parameters for your initial forms in the iFrame widget. Because the iFrame URL allows you to
modify the URL to add data types, you can now directly populate data from a host application for
form elements without having to keep re-entering the data.
Deploy automations in web application alla pagina 2234 | Parametri URL alla pagina 2153

Virtual window support for iFrame widget
You can now run your bots in a virtual window (picture-in-picture view) for AARI Integrations.
With this option, you can run an attended bot in a small virtual window on your screen (instead of
another desktop page or application) simultaneously while you complete tasks on the same page
without obstructing your automation experience.
Deploy automations in web application alla pagina 2234 | Configure an AARI bot alla pagina 2174

Select tags in widget setup
When you configure your widget in the Integrations page, the Filter automations option allows
for you to select existing tags that can be added to your widget. You can now reference tags with
the corresponding widgets in the widgets tab for easier reference in the tags column.
Setup iFrame widget using AARI Integrations alla pagina 2225

View status and run time details in automation list
You can now view the status and run time of your bots and processes in the automation list. The
status and run time are based on your bots and processes last activities. You can quickly review
whether a bot was completed in x amount of days or time ago, or shows no activity at all.
Deploy automations in web application alla pagina 2234

AARI shortcut link
You can now access AARI directly from your RPA Workspace. The Explore AARI link in the new
AARI tab from the homepage is a shortcut that redirects you to the AARI portal. This is an easier
way for you to access AARI if you forget how to access AARI or need to modify the URL to access
AARI.
Distribuisci processi alla pagina 2155
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New actions in the Process Composer
In the Process Composer, you can now use a set of actions when you build out your process. For
example, you can double-click a task, such as Bot Task and Human Task, and the task will be
updated in your process flow automatically. With this, you can save time because you do not need
to task specific tasks to your process. In addition, you can now copy, cut, and paste using CTRL +
C, CTRL + X and CTRL + V, respectively to retain, reuse, or replace data.
Behaviors supported in the Process Composer alla pagina 2144 | Crea un processo AARI alla pagina
2133

Use a reference ID meta type in Process Composer
You can now use a reference ID with a Meta variable type for your variables in the Process
Composer. When you set a reference ID as a meta variable type, you can now use your reference
ID data when you run your tasks in the web interface. This simplifies your references because you
only need to rely on using the reference ID instead of relying on other variable types or references.
Crea un processo AARI alla pagina 2133

Center your forms in preview
You can now preview your forms in the new preview window and get an accurate assessment on
how your form will look when it is rendered. You can select the Make form preview centered
option to enable the preview window. You can also set the appropriate display resolution, x and y
coordinates, and even center your form.
Create a form alla pagina 2186

Upload images directly to the form composer
You can now upload images directly to the form composer by using the Image element. This saves
you time to view the images in the form without a file reference, rather than in the initial step,
where the image requires a file reference to be viewed.

Nota:  Image files are limited to 150 kb (like a logo).

Using the Image element alla pagina 2195

Change label action for Button element
The change label action in the form rules now applies to the Button element. When you use the
change label action in form rules and apply it to the buttons in your form, the changes will be
automatically applied to the buttons where you set the rules. This keeps the flow consistent with
the elements that you are using because all the buttons inherit the same rule.
Aggiunta di regole agli elementi di un modulo alla pagina 2202

Rules editor for Table element
The rules editor is now applicable to the Table element. When you use the rules editor for your
tables, the rules conditions are applied for each individual columns while any actions that you set
are applied for each row in the row level. This makes things consistent for each new or existing row
that you use because all the rows inherit the same rule.
Aggiunta di regole agli elementi di un modulo alla pagina 2202

Cosa è cambiato

Build 16701: This build includes the following enhancement:
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Enhanced automation experience in AARI Assistant
We have improved the automation experience for your automation activities in AARI Assistant.
• You must have the Manage my activity permission as a prerequisite to use the bot controls.
• When you run your automation, the bot, its progress page, controls for pause, start (resume),

and stop, are all unified inside AARI Assistant. Previously, there was a seperate window for
the bot run and its controls. (This will still be seen in this version but will be hidden in future
releases.)

• You can view the status of your bot progress and its details, and is reflected on the activity
page.

• You can view and manage pending automation that have been initiated and users can navigate
between bot list view and progress view. If you have multiple AARI Assistant instances or
disconnect and then reconnect to a different instance, the pending automation will be visible
from the progress page for you to control.

Service Cloud case ID: 01793119, 1815462
AARI Assistant automation activities alla pagina 2181

Build 16667: This build includes the following enhancements:

Define tags in process configuration
When you edit a process, you can use the Tags field to search and specify tags based on
keywords, to define your process. You can add tags from new or existing tags and use them to
reference specific tags related to your process.
Configure an AARI process alla pagina 2175

Correzioni

Build 16701: This build includes the following fixes (along with fixes from the previous builds):

In AARI Assistant, you can continue your pending automation in different AARI Assistant instances.
Automations are no longer stuck, and you can run bots as usual.
Service Cloud case ID: 01829572

Nota:  This fix was first included with Build 16694 for Cloud Sandbox and Community Edition. Build
16701 now includes this fix for Cloud, Cloud Sandbox, and Community Edition.

Build 16685: This build includes the following fixes (along with fixes from the previous builds):

When bots have a file dependency or an interactive form that includes any multibyte character in its
name, the bots run as expected. Previously, having the multibyte character in a form name caused
an error.
Service Cloud case ID: 01947340

Build 16667: This build includes the following fixes:
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You can now view signatures when you preview files using the AARI document viewer. Previously,
signatures could be viewed only when files were opened in a separate tab.
Service Cloud case ID: 01879533

Bots are no longer triggered when you modify a file in an authenticated network. Previously, bots
would trigger when you modified a bot in a network that required authentication.
Service Cloud case ID: 01256344, 01756709, 01854164, 01888188

The resiliency of the Create > Request action has improved in the Process package.
Service Cloud case ID: 01886231

You can add, delete, and change values to the column cells when you create forms using the
Column Filter function. Previously, an error altered the accuracy of this operation by sometimes
changing rows or filtering newly edited values.
Service Cloud case ID: 01854490, 01941416

When scrolling past 100 task bots in AARI Assistant page, fresh bots now load to successfully
complete the list of bots not yet displayed.
Service Cloud case ID: 01804139, 01845208, 01881927

You can select Reference ID as a Meta variable type from the Variable drop-down list.
Service Cloud case ID: 01861551

When you enter data in a password field in the initial form, the password field retains your data
after you submit the form without requiring you to re-enter the data.
Service Cloud case ID: 01846222

When you use a file element to select multiple files, the file element functions properly without
having to reset the form.
Service Cloud case ID: 01840888

Buttons in forms work as expected. Previously, some users encountered an exception error and
were unable to click Confirm to submit their form.
Service Cloud case ID: 01846856

When you run a bot in AARI, you can edit the auto-populated fields after you select an option from
the drop-down menu.
Service Cloud case ID: 01853623

When you use a number element and enable the Use comma to separate thousands format
option, the bot will run without issues. Previously, some users encountered an exception error.
Service Cloud case ID: 01869566

When you use the File modified trigger option to modify the contents or files, the trigger works
properly.
Service Cloud case ID: 01812596

When you use a document element in your form to upload PDF files, the PDF files that are
uploaded renders the contents properly.
Service Cloud case ID: 01802898, 01833266
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Known Limitations

Image files uploaded to forms for access in the Process Composer are limited to 150 kb.
Example of uploading and downloading file for web alla pagina 2127
Service Cloud case ID 01922815

Aggiornamenti dell'interfaccia
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AARI

The form builder now automatically adjusts the size for each form element you drag into the
canvas. The sizes can also be manually adjusted.

Build forms easily by dragging elements to form builder

© 2023 Automation Anywhere. All rights reserved.     160



    Automation Anywhere - Learn

AARI

The Tags field in the Edit Process page now has a drop-down menu for you to create new or select
from existing tags.

Define tags in process configuration
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AARI

The Filter automations field in the Add Widget page has a drop-down menu for you to select
existing tags.

Select tags in widget setup

Riferimenti correlati
Note sulla versione Automation 360 v.27 alla pagina 97
RPA Workspace v.27 release alla pagina 100
Review what's new and changed, and the fixes and limitations in RPA Workspace for the v.27 release.
Process Discovery v.27 release alla pagina 153
Review what's new in Process Discovery for the v.27 release.
IQ Bot and Document Automation v.27 release alla pagina 162
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.27 release.
Bot Insight v.27 release alla pagina 170
Review the fixes in Bot Insight for the v.27 release.
Packages updated in v.27 alla pagina 129
Review updates to the packages in Automation 360 v.27, including the compatible Control Room and Bot
Agent versions.

IQ Bot and Document Automation v.27 release
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.27 release.
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Document Automation

Novità

Standard forms integrated with Document Automation
You can create and manage learning instances entirely within Document Automation. Previously,
you had to create standard form learning instances in IQ Bot and then process them through the
Connect Learning Instance feature in Document Automation. With standard forms integrated
with Document Automation, you benefit by having an entire workflow consolidated into a single
system.
Using Document Automation for Standard Forms alla pagina 2598.

Support for Microsoft Form Recognizer v3.0 models in Document Automation
Microsoft Form Recognizer v3.0 provides additional capabilities to the existing model creation,
including options to select Template and Neural. While training a model, you can select either 2.1
or 3.0 version.

New Document Automation product licenses
Document Automation now offers the following licenses to enable users to process documents and
track metrics for learning instances in production:
• Document Automation Standard Forms (Number of pages): Required to create a model and

process documents in a Standard form in Document Automation.
• Document Automation 360 Extraction (Number of pages): Required to process documents in an

Automation Anywhere (Pre-trained) model, including the User-defined document type.

Also, there are updates to license consumption tracking.
License tracking release note

Extract data with Google Vision OCR
If you are a user with a Cloud Control Room, you can process documents using Google Vision OCR
technology by creating or updating a learning instance.

Improved table extraction in Automation Anywhere models
You can use validation feedback to train a learning instance to extract data from a cell that contains
more than one field.
For example, if a product description column also includes item number, you can outline the item
number in the Validation interface. When the learning instance processes subsequent documents, it
will extract the item number and ignore the product description.
Using validation feedback to extract specific values in a table alla pagina 2573

Visualize performance metrics with a new Document Automation widget
You can view data visualizations on Validator user performance. This new widget is a horizontal bar
chart that shows the weighted average time each Validator user spent performing manual validation
per document.
Document Workspace dashboard alla pagina 2963
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Novità

Document Automation supports regular expression pattern-based extraction
When configuring fields that the learning instance will extract, you can specify a regular expression
(regex) pattern to help the extraction engine find the field. After entering the regex pattern you can
test the expression using sample content within the Create Learning instance window. You can
use regex pattern extraction for values that follow a specific pattern, such as a VAT number or a PO
number.

Validation interface support for shortcut keys
Zoom in and out on documents in the Validation interface by holding the Alt key and scrolling with
your mouse wheel.

Cosa è cambiato

The following updates impact how the Control Room tracks license consumption:
• The Control Room checks enough product licenses prior to deploying the bot.
• The IQ Bot Pages license and the Standard Forms Pages license track documents that are

processed through learning instances created in Automation 360 IQ Bot. This includes
documents processed in the learning instance in Automation 360 IQ Bot and learning instances
connected to Document Automation.

• In the Licenses page, the Document AI license is called the Google Document AI (number of
documents)

• The Control Room also tracks documents processed in Google Document AI for users who
brought their own license. Previously, the Control Room only tracked such documents for users
who bought their licenses through Automation Anywhere.

You can now configure Oracle Database with on-premises and Linux installations of Document
Automation.

When you import a learning instance created in previous versions of Document Automation, the
check box to send validation feedback to the system is now not selected by default. You must edit
the learning instance to select the check box.

Correzioni

Build 16694: This build includes the following fixes (along with fixes from the previous builds):

Now users with either the Standard Forms for Document Automation or the Standard Forms (for IQ
Bot) licenses can create a Standard Forms model in Document Automation.

Build 16685: This build includes the following fixes:

The Bot Agent now clears out the resources folder after running actions from the Document
Extraction package.

When you import a learning instance created in a previous version of Document Automation, the
Improve accuracy using validation check box is now unselected by default.

Document Automation now correctly tracks license consumption in all On-Premises installations,
irrespective of the port number.

You can now add formula validation to learning instances with the user-defined document type.
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Correzioni

Standard forms in Document Automation is now supported in a fresh installation or upgraded multi-
tenant Control Room. Previously, Standard forms in Document Automation was only supported on a
fresh installation of a multi-tenant Control Room.

When you refresh the Validator page, the Validator displays the last document you worked on.
Previously after a page refresh, the Validator sometimes displayed the first document you had
validated.

Bot Runner devices configured with a proxy can successfully run actions from the Document
Extraction package.
Service Cloud case ID: 01856276, 01862174, 01911425

Limitazioni

Standard forms only support unique field extraction for any document. If there are fields with the
same name on multiple pages, then the document must be trained with different tag names in the
model creation tool.
For example, if there is a field named date on two different pages, then you must use date1 and
date2 to make the tag names unique in the model creation tool for training.

You cannot use spaces in model names when you create models for Standard forms v3.0. If the
model name contains any spaces, then an InvalidParameter error message is generated.

There is no average accuracy for standard forms v.3.0 from the Microsoft Azure Form Recognizer
service. As a result, the standard forms training displays the average accuracy as 0.00% for the
v.3.0 service.

When fetching a Standard Forms model, an incorrect error message displays when no
configurations are available in Document Automation.

The resizing functionality is not working properly for the model list table. As a result, you cannot
resize the table header or column in Standard Forms.

The run analysis result does not display in standard forms when creating a v.3.0 model with
multipages.

There is a default character limit of 100 characters for the table name, and 155 characters for the
field name of the table. However, if you reconfigure the table, you can add more characters than
the default limit.

The System-Identified Regions (SIRs) for checkboxes or radio buttons are not generated for the
standard forms v.3.0 model.

Standard forms is not supported on Linux.

Any re-mapping or re-drawing in the System-Identified Regions (SIRs) in the Validator results in
detection of an incorrect check box. However, you can enter the check box value as checked or
unchecked after changing the auto-generated mapping.

When migrating a learning instance from one Control Room to another, the same user must export
and import the .dw file.
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Limitazioni

If the learning instance extracts data from a multi-line field and transfers it to a CSV file, an extra
space is added at the end of each line.

When you mouse over data points in the "Average validation time" and "Validator performance
by number of documents" widgets, the correct values do not immediately display in the pop-up
window.

Document Automation prevents you from creating a learning instance if you create a custom table
field without providing a field name and field label, even if you have unselected the field.

If you click Test regular expression and replace the value in the Regular expression field, the
field now has a limit of 50 characters.
Soluzione: Click Cancel to leave the Test regular expression window and make the revisions in
the Regular expression field.

The Table icon is not generated on the Form OCR Testing Tool (FOTT) for the Standard form v3.0
Model.

If a field name contains more than 100 characters, the scroll bar does not appear and you cannot
see the value of the form field.

If a table name contains more than 50 characters, you cannot expand the table size. Additionally,
the field name in the table does not display when you hover over it.

If you test an invalid Python script when configuring custom logic, the system returns an error
message that contains the Python execution path.

Sometimes document extraction fails and one of the following error messages appear in the AARI
request status: Extraction bot failed. Please check activity/audit logs for
 more detail or Download bot failed. Please check activity/audit logs for
 more detail with this message in the audit log: Existing deployment in progress for
 this user session.
If this happens, restart the Bot Agent on the impacted device.

The Document Workspace dashboard sometimes shows incorrect page consumption metrics if the
Control Room is installed On-Premises.

Documents cannot be processed with Google Vision OCR if your proxy is configured with a Proxy
Auto-Configuration (PAC) file.

When you create or edit a Learning Instance, if a field name starts with a numerical value, then the
formula validation for that field fails. This issue applies to form fields and table fields.

If you import a learning instance with the validation feedback option disabled, the validation
feedback option becomes enabled and you must manually edit the learning instance to disable the
option.

For Standard Forms, when a document with multiple pages is processed and enters into validation,
one page is being duplicated in the Validatoreven when the System-Identified Regions (SIRs) in the
Validator are correct.

© 2023 Automation Anywhere. All rights reserved.     166



    Automation Anywhere - Learn

IQ Bot

Cosa è cambiato

If you are using an older version of Microsoft SQL Server that does not support TLS 1.2, then you
must keep an IQ Bot database backup and update to a Microsoft SQL Server version that supports
TLS 1.2.

IQ Bot now uses the latest version of Python (3.11.0) for custom logic validation. To use the latest
version, you must upgrade from cx_Oracle 8.3 to python-oracledb. See Upgrading from cx_Oracle 8.3
to python-oracledb

Correzioni

IQ Bot now performs post-processing on fields with Python custom logic that contain single
quotation marks, such as print('Test').

In IQ Bot, when a document is either corrupted, deleted, or is not loading in Validator or Designer,
a placeholder image is displayed. The applications will not be consistent until you upload new
documents.
Service Cloud case ID: 00792976, 00835371

During the production process, you must not move the learning instances or bots from Staging to
Production, or vice-versa.
Service Cloud case ID: 01808931, 00821541, 01253373, 00836954, 01271722

When you upload any invalid document in manual or custom groups, then the document gets
processed. However, the System Identified Region (SIR) will not be generated for the unsupported
pages.
Previously, when an invalid document was uploaded with a valid document and processed for
extraction, the See extraction page kept loading.
Service Cloud case ID: 01786098

In Healthcheck API, the output shows the proper branch name convention, for example: RC-
A360.27. Previously, improper health information was displayed when the branch name convention
was heads/RC-A360.27.

If an error or exception is encountered during document validation, the error or exception is
processed, and the files are displayed consistent in the output.
Service Cloud case ID: 00827940

In IQ Bot, if the RabbitMQ v3.8.17 and v3.8.18 is not working, then the log directory location
can now be changed by updating the system environment variable as RABBITMQ_LOG_BASE. If
this variable is provided manually with the required directory location, then the logs are created
and updated in a new location. Previously, the configuration given for the log.dir variable in
rabbitmq.conf file did not support RabbitMQ v3.8.17 and v3.8.18.
Service Cloud case ID: 01844995
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Correzioni

The system-identified regions (SIRs) are now generated for manual groups when the PDFBox is
enabled. Previously, when the PDFBox was enabled, during Learning Instance creation the SIRs for
some vector PDFs were not generated for manual groups.
Service Cloud case ID: 01844223, 01849638

You cannot import an IQ Bot archive (IQBA) file when the designer for the same Learning Instance
is open in another window. Previously, the import was failing because the LockedTimestamp field
in the visiobotDetails table had a value at the time of IQBA export. This caused an error because
the LockedTimestamp field was expecting a null value.
Service Cloud case ID: 01818474

Limitazioni

During the express installation upgrade of IQ Bot, an error message is shown in the installation
steps. You must click OK to proceed further.

The maximum upload file size limit is set to 5 GB when importing and exporting files in the IQ Bot
archive (IQBA) file. If the file size is greater than 5 GB, then you must delete unwanted groups to
decrease the file size and migrate successfully.

If the IQ Bot archive (IQBA) file size is above 2,147,483,647 bits, then the File Storage does not
upload the exported file from output folder to the desired location.

Sometimes, the PDFBox is unable to detect PDF (Portable Document Format) documents accurately.
We recommend that you use Adobe Acrobat to convert the documents to PDF before you upload it
to IQ Bot.

Aggiornamenti dell'interfaccia
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IQ Bot e Document Automation

The Create learning instance window now contains a drop-down menu to select an OCR provider.

Extract data with Google Vision OCR

Riferimenti correlati
Note sulla versione Automation 360 v.27 alla pagina 97
RPA Workspace v.27 release alla pagina 100
Review what's new and changed, and the fixes and limitations in RPA Workspace for the v.27 release.
Process Discovery v.27 release alla pagina 153
Review what's new in Process Discovery for the v.27 release.
AARI v.27 release alla pagina 154
Review what's new and changed, and the fixes and limitations in AARI for the v.27 release.
Bot Insight v.27 release alla pagina 170
Review the fixes in Bot Insight for the v.27 release.
Packages updated in v.27 alla pagina 129
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Review updates to the packages in Automation 360 v.27, including the compatible Control Room and Bot
Agent versions.

Bot Insight v.27 release
Review the fixes in Bot Insight for the v.27 release.

Correzioni

In the Bot Insight Operations > Bots Dashboard, the bot duration shows the correct data.
Previously, there was a mismatch between the bot duration data and the manual calculation of the
bot duration from the historical menu because of a start time mismatch.
Service Cloud case ID: 01796106

When you upgrade to Automation 360 v.27 and launch the Control Room, no kernel bootup failure
occurs due to a failed Elasticsearch initialization. Thus, it does not show the Bad Gateway error.
As a result, the Control Room service is available and you can access the Control Room URL.
Previously, Elasticsearch initialization failed during startup which was causing the kernel bootup
failure. As a result, the Control Room service was showing the Bad Gateway error.
Service Cloud case ID: 01908667, 01919727, 01919309, 01911464, 01921747, 01926887,
01925309, 01924168, 01929814, 01930226, 01931125, 01925270, 01934212

You can check out and republish the dashboard with a new name for a specific bot after import it
into the public workspace.

Nota:  In case of public import, you must run the bot at least one time before you export it.

Previously, you could not publish the dashboard for a specific bot even if it was checked in.
Service Cloud case ID: 01763067

Aggiornamenti dell'interfaccia

Bot Insight

The Bot Insight user interface is changed as per Common Frontend Component (CFC) standards.
Only the look and feel of the components (such as colors, fonts, icons, paddings, borders, buttons,
and so on) is changed, while the underlying functionality remains the same. You can view these
changes from the following user interface elements:
• All Bot Insight pages
• Table pagination position at the center of the page
• The Create widget dialog back drop with the Close button
• Add Widget title in the Create widget dialog
• The Switch Widget button position in the Add widget window for all charts

Riferimenti correlati
Note sulla versione Automation 360 v.27 alla pagina 97
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RPA Workspace v.27 release alla pagina 100
Review what's new and changed, and the fixes and limitations in RPA Workspace for the v.27 release.
Process Discovery v.27 release alla pagina 153
Review what's new in Process Discovery for the v.27 release.
AARI v.27 release alla pagina 154
Review what's new and changed, and the fixes and limitations in AARI for the v.27 release.
IQ Bot and Document Automation v.27 release alla pagina 162
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.27 release.
Packages updated in v.27 alla pagina 129
Review updates to the packages in Automation 360 v.27, including the compatible Control Room and Bot
Agent versions.

Note sulla versione Automation 360 v.26
Data di rilascio: 6 October 2022

Review the top 5 features as well as other new features, enhancements, fixes, and limitations in the
Automation 360 v.26 release. Automation 360 and IQ Bot are on Build 15459 (for On-Premises and Cloud).
We have released updated builds for fixes after the GA release of v.26 (Build 15436). For information about
the fixes in these updated builds, see Updated release builds alla pagina 176.

Nota:  The release builds include Manifest V3 browser extensions for Google Chrome and Microsoft Edge
browsers. Per ulteriori informazioni, consulta:
• Chrome and Edge Manifest V3 extensions alla pagina 807
• Support for Manifest V3 extensions
• Browser extensions for Automation 360 alla pagina 718

Highlights of this release

Here are the top 5 features in the v.26 release:

Embedded automation with OAuth 2.0 Business users can directly access authorized
automation from within their favorite business
applications, without having to open a new
interface or learn a new app. OAuth 2.0 enables
seamless authentication across systems, reducing
complexities of system-specific sign-ins.
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Learn more: Embedded Automation alla pagina 2218.

Coding standards through code analysis Administrators can establish coding best practices
by setting a code analysis policy and improve
their team's code to quickly find and correct rule
violations. They can select which rules to check for
and enable summary reports for a snapshot of all
bots within a project.
Bot builders can quickly check the status of their
bots and receive feedback on what to fix, speeding
up bot development and deployment and promoting
coding best practices.
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Learn more: Analisi del codice alla pagina 2782.

Package role-based access (RBAC) Administrators can tailor package access to the
business needs and expertise of bot developers and
enforce access policies for custom groups. They
can maintain policy control and ensure confidence
and ease-of-use for developers by providing group-
based package access with clear policies.
Citizen developers can access simpler packages
and build easy-to-complete automation, and
professional developers can access a broader set of
complex packages.
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Learn more: RBAC on packages alla pagina 2641.

Salesforce integration with command
package

RPA developers can build robust integrations with
Salesforce through direct API interaction. They
can automate repetitive processes involving access
and updates to Salesforce data, enabling business
users to focus on high-value business tasks such
as strategic planning and optimization. Commands
available include authentication, database querying,
record updates, and file processing.
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Learn more: Salesforce package alla pagina 1791.

Automation 360 integration with Google
Cloud Apigee

RPA developers can fast-track end-to-end
automation development by combining API
components from Apigee and RPA bots from
Automation 360 to access any data in the
enterprise. Our prebuilt integration packages make
the integration seamless, enabling you to drive
more value from reusing existing assets created by
your organization's automation teams.

© 2023 Automation Anywhere. All rights reserved.     175



    Automation Anywhere - Learn

Learn more: Apigee integration.

Updated release builds

We have released the following updated builds:
• Build 15459 Service Cloud case ID: 01941769, 01945068

This build is updated to include a critical security fix for the issue related to Multi-Factor Authentication
(MFA) when used with database authentication. This vulnerability is not applicable when using SAML or
AD authentication. For more information on this security fix, see Unexpected behavior observed with Two
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Factor Authentication post A360.26 upgrade, where a valid authenticator code alone is sufficient to login to CR,
in spite of an incorrect password.

Nota:  This issue exists only in Automation 360 v.26 release. For v.26 On-Premises customers using or
planning to use MFA with database authentication, we recommend that you install this update at your
earliest convenience. No action is required from customers on other Automation 360 releases.

• Build 15450 with fixes for the following issues:
• When you import a bot or file that is a manual dependency of other bots using the overwrite option,

the import process no longer removes the dependencies from the other bots (Service Cloud case ID:
01911410, 01920508).

• When you have large and complex bots with many dependencies and if the size of the deployment
messages that are sent from the Control Room to the Bot Agent is more than 2 MB, the bots run
successfully. (ID caso Service Cloud: 01882630).

• The following IQ Bot issues were fixed:
• IQ Bot can now perform post-processing on a field if the custom logic uses Python script

containing single quotes, such as print('Test').
• If your IQ Bot custom logic uses the Pandas library, the script no longer needs to have the

import Pandas statement.
• IQ Bot can now perform post-processing on a field if the custom logic uses Python script

containing characters from non-Latin languages (Unicode characters), such as äöüñй.

• Security fixes for Cross-Site Scripting (XSS) vulnerabilities (Service Cloud case ID: 01843148).

• Build 15443 (for US-East and US-West regions only) Service Cloud case ID: 01911410,
01920508
This build is updated to include a fix for the issue related to the manual dependency file that is shared
between multiple parent bots upon export and import. If one of the child bot files is exported and
imported into the Control Room with overwrite options in the import process, then links to the manual
dependency are unlinked from other parent bots. Use Bot Agent version 21.222 for this issue.

• Build 15439 (Japan region only) Service Cloud case ID: 01911093, 01911209, 01911190,
01911116, 01911259
This build is updated to include a fix for the following issue: Cannot retrieve values assigned
 to global values having Japanese characters after upgrading Automation 360.
Build 15439 is available for download for On-Premises customers who need this fix.

What's new and changed in each product

Go to the following pages for details on all the updates (what's new, changed, fixed, and limitations) in
each product:

RPA Workspace

• Updating to this release
• Migration updates

AARI

IQ Bot and Document Automation

Bot Insight
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Concetti correlati
View package versions available in the Control Room alla pagina 2009
Actions are grouped into version-specific packages. Bot Creators can select which package version to use
for a specific bot.
Riferimenti correlati
RPA Workspace v.26 release alla pagina 178
Review what's new and changed, fixes and limitations, and the feature deprecations in RPA Workspace for
the v.26 release.
AARI v.26 release alla pagina 202
Review what's new and changed and the fixes in AARI for the v.26 release.
IQ Bot and Document Automation v.26 release alla pagina 204
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.26 release.
Bot Insight v.26 release alla pagina 211
Review what's changed and the limitations in Bot Insight for the v.26 release.

RPA Workspace v.26 release
Review what's new and changed, fixes and limitations, and the feature deprecations in RPA Workspace for
the v.26 release.

Novità

Control Room, devices and Bot Agent

Microsoft Windows 11 Enterprise now supported (Service Cloud case ID: 01252605,
1252605, 1253745, 01255134, 01379865, 01801610, 01810148)
We now support Microsoft Windows 11 Enterprise, so you can now install and update the Bot Agent
and run bots on the Windows 11 Enterprise operating system.
Compatibilità di Bot Agent alla pagina 1025
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Control Room, devices and Bot Agent

Support for Manifest V3 extensions
Automations that use Google Chrome Manifest V2 based extensions will stop working sometime
after June 2023. The deprecation timelines of Manifest V2 based extensions are currently under
review and subject to change by Google.
• For Google Chrome Manifest V2 extensions timelines, see Manifest V2 support timeline.
• For Microsoft Edge Manifest V2 extensions timelines, see Overview and timelines for migrating to

Manifest V3.

This might impact your existing automations that use Manifest V2 based extensions for Google
Chrome and Microsoft Edge browsers. Automation 360 v.26 and later includes Manifest V3
extensions by default to support features that use Google Chrome and Microsoft Edge browsers.
You can automatically enable Manifest V3 based extensions for Google Chrome and Microsoft Edge
on all the Bot Runner devices by enabling the Browser extensions option from the Control Room.
Enabling this option applies the browser extension settings on all the registered Bot Agent devices.

Nota:  We will continue to support Manifest V2 based extensions for Google Chrome until June
2023. To know about Microsoft Edge Manifest V2 based extensions timelines, see Overview and
timelines for migrating to Manifest V3.

Nota:  Manifest V3 extension is supported on Google Chrome and Microsoft Edge browsers version
91 and later only.

Configure browser extensions alla pagina 2728 | Chrome and Edge Manifest V3 extensions alla pagina
807

Bot Agent updates by using installation file from local drive
You can now download the Bot Agent installation file to your local drive as a one-time activity and
then update the Bot Agent on several devices by providing the local drive path to the installation
file. This way, you can avoid downloading the installation file multiple times from the Control Room
for several devices.

Importante:  This functionality is implemented in v.26 and can be used from v.27. That is, after
you update your Bot Agent to v.26, future updates can be performed from the local drive.

Aggiornamento automatico di Bot Agent alla pagina 1042 | Update the Bot Agent from a local drive alla
pagina 1043

Oracle Database now supported (Service Cloud case ID: 00726728)
We now support Oracle Database, so you can now choose to install the Control Room on Oracle
Database.

Nota:  Oracle database for Control Room installation is supported only in Custom mode and not in
Express mode. Oracle Database support on the Control Room starts with the v.26 release.

Installing Control Room using custom mode for Oracle installation alla pagina 901 | Configure Oracle
database type and server alla pagina 914 | Database requirements alla pagina 845
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Control Room, devices and Bot Agent

Active Directory mappings filters stored in the database
When you update to a newer version of the Control Room, you no longer have to define the Active
Directory mapping filters again after installation. This is because the Active Directory mapping filters
defined in the um.properties file are now stored in and can be referenced from the database.
However, if you define new filters in the um.properties file, the Control Room references the
filters defined in the um.properties file and overwrites the ones stored in the database.

Packages, actions e Bot editor

RBAC on packages
Based on your business requirements, you can now control the access that Bot Creators have to
packages in the Control Room. As an administrator or user with the Manage package permission,
you can restrict access to packages to either all the users or users with specific roles.
Depending on the access that is configured by the admin, Bot Creators and Citizen Developers can
view and use specific packages:
• Bot Creators can access a broad set of complex packages and create bots, which can be reused.
• Citizen Developers can access simpler and easy-to-use packages and build automations quickly.

RBAC on packages alla pagina 2641 | Configure RBAC for packages alla pagina 2644

Salesforce command package
You can now authenticate from Automation 360 to access Salesforce and run several command
actions by using the new Salesforce command package.
Salesforce package alla pagina 1791

SAP GUI 770 version now supported (Service Cloud case ID: 01793132, 01792775, 1776805,
01792623, 787725, 01805482, 01805479,01792623, 01810356, 01822839, 01851451, 01853577,
01860050)
SAP GUI 770 (patch 6) is now certified and supported with Recorder and SAP package.
Recorder actions supported in various SAP versions alla pagina 1772

Configure and use custom proxy configuration in REST Web Service package (Service
Cloud case ID: 01271527, 01765084, 01839282)
REST Web Service package is now enhanced to support custom proxy configuration for each
Delete, Get, Patch, Post, and Put action. This provides you more flexibility in calling REST APIs
with different proxy configuration and allow you to create hybrid API automation.
REST Web Service package alla pagina 1777

Keyboard shortcuts to reduce scrolling
When developing large bots, you can now use keyboard shortcuts to expand and collapse individual
or all sections and move through the lines of code quickly instead of scrolling and minimizing
sections individually.
Keyboard shortcuts to expand or collapse elements in bot logic alla pagina 1362
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Packages, actions e Bot editor

Set value in any editable control field to be blank in SAP application (Service Cloud case
ID: 00821861, 01807129)
When you use the Set text action of the SAP package, you can now set the value in any editable
control field in the SAP application to be blank. For example, you can set the value in the text field
or the date field to be blank.

Loop through emails and move them one at a time (Service Cloud case ID: 00749763,
01807189, 01840743)
You can now loop through all the emails in a mailbox and move one email at a time to a destination
folder by using the Move action in the Email package.
Move action alla pagina 1507

Configure p12 certificate for SOAP-based automations (Service Cloud case ID: 00757213)
In the SOAP Web Service action, you can now select the p12 certificate file and provide a password
for user authentication. With this enhancement, you can now access web services that use the p12
certificate-based authentication (a more secure type of SSL certificate).
Esempio di utilizzo dell'azione Servizio Web SOAP alla pagina 2076

Improved accessibility, usability of content on Terminal Emulator window (Service Cloud
case ID: 01609467)
You can now have improved accessibility and usability of the content displayed on the Terminal
Emulator window. When you use the enhanced Get text action of the Terminal Emulator package,
you can now view and extract all the lines and text present in the Terminal Emulator window and
perform an operation based on your requirement.
Using Get text action for Terminal Emulator alla pagina 1908

Run bots with or without window title matching in letter case
You can now run bots even when the title of a captured window does not match the letter case. For
a bot to identify a static window or browser titles and titles with a wildcard character, you can opt
for a case-sensitive match if you want the letter case to be matched, or a case-insensitive match
otherwise, by using the Case sensitive option.

Control image preview and storage in Control Room during secure recording
You can now choose whether or not the object images are available for preview and stored in the
Control Room during secure recording by enabling the Recorder preview image setting. When
you enable the setting, the image is previewed in the Bot editor and stored in the Control Room for
60 minutes. If you choose not to preview, images are not captured.
Registrazione sicura alla pagina 37 | Secure recording mode alla pagina 1964 | Impostazioni alla pagina
2721

Automate Microsoft Excel spreadsheets from SharePoint
You can now automate Microsoft Excel spreadsheets that are uploaded and shared on SharePoint.
Use Excel advanced > Open action to open the Microsoft Excel spreadsheets from SharePoint
location.
Using the Open action for Excel advanced alla pagina 1539
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Packages, actions e Bot editor

Automate Citrix Virtual Apps in Edge with IE mode
When using the Recorder, you can now automate Citrix Virtual Apps running on Microsoft Edge
Chromium with IE mode.

Automate controls using Microsoft UI Automation (COM) technology
For automation, you can now use the Microsoft UI Automation (COM) technology in the following
scenarios:
• Capturing controls with secure recording mode
• Capturing and automating combo box and list view controls
• Using Object exists and Object does not exist Recorder conditions in If, Loop, and Wait

packages

Capture using specific technology alla pagina 1770 | Actions performed on objects captured with Universal
Recorder alla pagina 1755

Seamless automation of Citrix Virtual Apps and other Citrix applications
With the new Automation 360 remote agent for Citrix, you can now seamlessly automate all types
of Citrix Virtual Apps and other Citrix applications that are supported on desktop applications using
the Recorder.
The new Automation 360 remote agent for Citrix supports the following browsers and technologies:
• Google Chrome
• Internet Explorer
• Microsoft Edge
• Microsoft Edge con modalità IE
• Mozilla Firefox
• Java
• Electron apps
• Microsoft Active Accessibility (MSAA)
• Microsoft UI automation

Installing Automation Anywhere remote agent on Citrix servers alla pagina 882 | Using the Recorder on
Citrix Virtual Apps servers alla pagina 878

Importante:  For information about the supported packages for this release, see Packages updated in
Automation 360 v.26 alla pagina 2010.
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Building and running bots

Implement coding standards with code analysis
You can now implement best coding practices by configuring coding rules in the Control Room.
This feature helps you prevent potential errors, improve bot reliability, and makes the code more
uniform, accessible, reliable, and efficient.
• As an administrator or a user with View policies and Manage policies permission, you can

configure the code analysis policy for all users.
• As a Citizen Developer, you can run code analysis to analyze your bots against readability,

maintenance, security, and compliance best practices.

Analisi del codice alla pagina 2782

Choose specific version of child bot to check out with parent bot (Service Cloud case ID:
01771388)
When you check out a parent bot, you can now choose the version of the child bot to check out.
Every version of a parent bot can have different versions of child bot dependencies. With this
feature, you can roll back the dependencies while rolling back the parent bot. You can make
changes to a specific version of the dependent bot.

Easily move bots and files between folders in the private workspace (Service Cloud case
ID: 00733125)
You can now move bots and files effortlessly and without requiring any permissions from one folder
to another in the private workspace. With this feature, if a bot is placed in an incorrect folder, you
no longer have to clone it in the correct folder and then delete it from the incorrect folder.
Move a bot alla pagina 1996

Better organization with bulk checkin of related bots and files
You can now select multiple bots or dependent files from different folders that belong to the same
process and check them in, in bulk, from private to the public workspace with the same check-in
message. You can check in a maximum of 10 parent bots, but there is no limitation on the number
of dependent child bots.

Email notifications for failed checkins (Service Cloud case ID: 01598642)
As an administrator, you can now configure sending email notifications to bot developers whenever
their checkins fail. Without such email notifications, bot developers will be unaware of their failed
checkins because although the checkin status is always logged in the audit log, they cannot access
the audit log access without permission. With email notifications, bot developers can know about
their failed checkins and retry immediately.

Export work items for offline records (Service Cloud case ID: 01769378, 01798514)
You can now export work items to a CSV file for offline audits and records. With this feature, you
can export selected, filtered, or all work items to a CSV file.
Export work items to CSV file alla pagina 2827
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Building and running bots

Export and import queues for efficient and flexible usage
You can now export and import queues across development, testing, and production environments.
This way, you can create a queue in the development environment, test it in the testing
environment, and then promote it to the production environment to efficiently execute business
process workload. You can also include work items when importing a queue.
Esporta code alla pagina 2821| Importa code alla pagina 2823

APIs and integrations

Connect Bot Agent to Control Room through v1/registration/auto API
You can now use the V1/registration/auto API to register and connect your device to a
Control Room automatically. You must specify the Control Room URL and the userName properties
in the API Request.
Bot Agent API: Auto registration alla pagina 3009

Fetch execution details for specific execution IDs with new Control Room API
You can now fetch the execution details, such as botOutVariables and CallbackInfo, for a
specific execution ID by using the new API endpoint, V3/activity/execution/<id> API.

Authorization with bearer token
Automation 360 supports the Authorization header with a Bearer token for API requests to the
Control Room. This header was previously unsupported and ignored on API requests. Obtain the
Bearer token from our OAuth services. All API calls must contain either an authentication token from
Authentication API (generates JSON Web token) or a bearer token from OAuth services. You cannot
use both together in an API.

Cosa è cambiato

Control Room, devices, and Bot Agent

Missed schedules redeployed automatically
You can now ensure that schedules missed because of Control Room shut down (Control Room
maintenance or upgrade) are automatically redeployed.
When you use the Redeploy the schedule again option, an audit log entry identifies the event
type as Schedule misfired, and the bot is automatically redeployed after the Control Room is
restarted.

Low disk space issues resolved with automatic deletion of temp files
Automation 360 now supports automatic clearing of the files in the temp folder, thereby resolving
low disk space issues.
During bot import operations, temporary files were written to the following path, leading to
increased usage of disk space and resultant low disk space issues: C:\Users\<aa cr admin
 account>\AppData\Local\Temp. As a result, the bots failed, and the temp files had to be
cleared manually.
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Control Room, devices, and Bot Agent

Enhanced Active Directory role mappings page
The Active Directory role mappings page no longer has default validation of mappings.
Validating all the role mappings can take a longer time on slow networks and with a higher number
of mappings because it requires communication between the Control Room database and the
Active Directory server. Also, changes in security groups and roles are infrequent and do not require
frequent validation on this page. The Active Directory role mappings page now displays only the list
of mappings which loads at a faster speed as validation of mappings is not done.

Enhanced autologin functionality for Bot Agent (Service Cloud case ID: 01788805)
Bot Agent autologin now works successfully even if the Interactive logon: Do not require CTRL
+ALT+DEL group policy is disabled.
Previously, for the Bot Agent to autologin successfully, you had to enable this group policy, which
was not possible due to the security policy. As a result, Bot Agent autologin failed.

Improved administration for WLM automations
You can now view all the queues with the AAE_Admin role. Also, you can pause, resume, and stop
all WLM automations.

Nota:  If you are not an owner, participant, or consumer of that queue, you can view only queue
names and not the queue details.

Packages, actions e Bot editor

Run DLL file without namespace (Service Cloud case ID: 01765712)
You can now run a DLL function even if the namespace is not specified because the Enter the
namespace field in the Run Function action of the DLL package is now optional.

Casing and format changes in Technology and Control types
When you use the Recorder to capture objects, you can now read and identify the names of
technology types and control types easily because the names of the properties now use a more
user-friendly casing and format. For example, MS_ACTIVE_ACCESSIBILITY is renamed Microsoft
Active Accessibility.

Correzioni

Build 15459: This build includes the following fixes (along with fixes from the previous builds):

A critical security fix for the issue related to Multi-Factor Authentication (MFA) when used with
database authentication. This vulnerability is not applicable when using SAML or AD authentication.
For more information on this security fix, see Unexpected behavior observed with Two Factor
Authentication post A360.26 upgrade, where a valid authenticator code alone is sufficient to login to CR, in
spite of an incorrect password.
Service Cloud case ID: 01941769, 01945068

Build 15450: This build includes the following fixes (along with fixes from the previous builds):
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If you have large and complex bots with many dependencies and if the size of the deployment
messages that were sent from the Control Room to the Bot Agent is up to 5 MB, then the bots will
run without failure.
Previously, bots were failing to execute when the size of the deployment messages that were sent
from the Control Room to the Bot Agent was more than 2 MB.
Service Cloud case ID: 01882630

When you import a bot or file that is a manual dependency of other bots using the overwrite
option, the import process no longer removes the dependencies from the other bots.
Previously, manual dependencies were removed for the overwrite option from the other bots during
bot import.
Service Cloud case ID: 01911410, 01920508

You can select a path containing a dollar sign ($) in a folder trigger for a file and folder, and the
bot will execute successfully. Previously, the bot failed when you selected a path containing a $ in a
folder trigger for a file and folder.
Service Cloud case ID: 01829534

Build 15443 (for US-East and US-West regions only): This build includes the following fixes (along
with fixes from the previous builds):

When you import a bot or file that is a manual dependency of other bots using the overwrite
option, the import process no longer removes the dependencies from the other bots.
Previously, manual dependencies were removed for the overwrite option from the other bots during
bot import.
Service Cloud case ID: 01911410, 01920508

Build 15439 (Japan region only): This build includes the following fixes (along with fixes from the
previous builds):

You can now successfully retrieve values assigned to Global values with Japanese characters after
upgrading the Control Room to the Automation 360 v.26 release.
Service Cloud case ID: 01911093, 01911209, 01911190, 01911116, 01911259

Build 15436: This build includes the following fixes:

You can now successfully delete a device from the device pool without any error.
Previously, when you deleted a device from the device pool, it was deleted from the Control Room
but remained in the DEPLOYMENT_ALLOCATION_QUEUE table. Hence, the device could not be
deleted and an error was shown.
Service Cloud case ID: 01791502, 1840575

If you run a bot from the Bot editor workspace for debugging using the Run from here option and
if the bot contains packages that use the session (Local or Global session), the following compiler
error no longer occurs: Unable to find any open session
Service Cloud case ID: 01080318, 01759454, 01785168, 01790014, 01786670
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In a multi-user environment, for simultaneous bot deployments, bot launcher logs are now
generated for all the users.
Previously, in such cases, bot launcher logs were not generated for all the users.
Service Cloud case ID: 01759506

You can now successfully list a scheduled task, and the following error no longer occurs: Unknown
timezone ID:US-Pacific-New

Previously, an unsupported time zone could be selected, which resulted in this error.
Service Cloud case ID: 01759074

If a device is shared between a Bot Creator and a Bot Runner, when you try to edit a schedule, the
following updated message is now displayed: UNKNOWN: All runAsUser(s) should have
default device as no pool is provided. RunAsUser(s): [dprunner] does not
have a default device or that device is shared with a bot creator

Previously, if a device was shared between a Bot Creator and a Bot Runner, when you tried to
edit a schedule, the following incorrect message was displayed: Automation failure due to
deploy failure

When you update the Bot Agent from user level to system level, you can now capture objects
using the Recorder actions or from a window list in a Google Chrome browser. You no longer have
to manually delete the registry entry in Windows from the current user level (HKEY_CURRENT_
USER).
Service Cloud case ID: 00731155, 00778022

After connecting to a device, when you set the global cache location to an invalid path, an audit log
entry is generated against the device, and the default global cache path is now used.

Nota:  Depending on the device used and the path you specified on your drive, validation of the
default cache path might not be supported.

When you want to edit a DataTable variable in debug mode, you can now scroll horizontally to view
all the columns in the DataTable variable.
Service Cloud case ID: 01818834

In the FTP / SFTP package, you can now create bots using actions such as Delete files, Put files,
and Get files even if the file name contains characters such as the comma (,) and the colon (:).
Previously, characters such as the comma (,) and the colon (:) were not supported in file names.
Service Cloud case ID: 01772186

You can now run an Enterprise 11.3.3 bot from Automation 360 in the Enterprise 11 Control Room
by using the Run action.
Previously, the Run action did not work for v.11.3.3 because the device V1 API was not working
with an empty filter for release 11.3.3.
Service Cloud case ID: 00825696, 01747999
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You can now successfully connect to the Excel or Access (Microsoft Office 2016 or later) engines
with ODBC drivers.
Previously, if you tried to connect frequently to the Excel or Access (Microsoft Office 2016 or later)
engines with ODBC drivers, bot execution failed intermittently.
Service Cloud case ID: 01762290, 01755335, 01778149, 01778899, 01793064, 01788154,
01810754, 01806851, 01811703, 1815437, 01807133, 01799364, 01755642, 01749480, 01767869,
01807133, 01818989, 01815300, 01826839, 01804882, 01842384, 01846477, 01762300, 01331003

When you send an email with multiple file attachments and if attachment size exceeds 24 MB, the
bot now waits for 120 seconds before encountering a timeout error.
Previously, when you sent emails with a large file attachment, bot execution failed after 30 seconds
if the attached file exceeded the file size.
Service Cloud case ID: 01763214

When you use the Connect action to connect with the EWS protocol, the Send email action and
read email now print the email message body in a new line character in the following scenarios:
• When you create a bot and connect with the EWS server, then use the Loop action to read

email as a plain text messages, and then use the Log to file action to log text into a file.
• When you use the Send email action and connect with the EWS server with OAuth

authentication to send email.

Service Cloud case ID: 01770645, 01780628

In the Email package, when you use the Move all action and establish a connection with the EWS
server, if the destination folder contains any of the following special characters in the folder name,
then use a backslash (\) as escape character before the special character: , + , * , ? , ^ ,
 $ , ( , ) , [ , ] , { , } , | , \

For example, if the destination folder name is "4) folder name", enter it as "4\) folder
 name".
Service Cloud case ID: 01803958

If your bot contains an error, Bot error now shows the correct line number of the error within
the Finally block in the following scenario: When you add the Try/Finally block around the
corresponding action, then insert more actions in the Finally block, and then save and run the bot.

You can now successfully upload files whose file names are in the Japanese language by using the
Rest web service action with multipart form data.
Previously, file upload did not work for files whose file names were in the Japanese language.
Service Cloud case ID: 01801767

You can now use the Terminal Emulator package to perform tasks associated with the terminal
without any issues. We now provide support for the Start PC Command (STRPCCMD), so when you
run the bot, the terminal now successfully opens the application with the STRPCCMD command.
Previously, when you passed the appropriate key on the Terminal Emulator, the bot did not open
the expected application because the STRPCCMD command was not supported in the Terminal
Emulator.
Service Cloud case ID: 01816577
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In the Terminal Emulator package, you can now use the Connect action to connect with a host
machine on which you want to automate a task.
Previously, when you used the Connect action, a black screen was displayed for a few terminal
hosts.
Service Cloud case ID: 01823081, 01841800

After migration, when you open a Load Add-ins-enabled Excel file using the Excel advanced >
Open action and run a bot, the bot now runs successfully without any error.
Previously, the bot failed because some Excel files with the Load Add-ins option enabled stopped
functioning and the workbook was closed unexpectedly.
Service Cloud case ID: 00950745, 01835066

When you use the PDF > Merge documents action and select All pages option in the Pages
field to merge all pages of multiple PDF documents into a single PDF document, the output PDF
now retains and merges all the attributes such as bookmarks, links, layers, attachments, and
signatures from the individual source documents.
Service Cloud case ID: 01792105

When the Recorder fails on a computer where the operating system language is not English,
the error message for the bot runtime failure is now shown in the same language as that of the
operating system.
Previously, the error message was shown in English even on computers where the operating system
language was not English.
Service Cloud case ID: 01813050

You can now successfully extract text from within the captured area of a window using the App
Integration package even if the screen resolution is more than 100 percent.

Automate and capture window authentication dialog boxes in the Google Chrome browser using a
specific technology with the Recorder.

Bots are no longer stuck when you work with Microsoft Access database queries.
Service Cloud case ID: 01756390

You can now open local files by using the New window option in the Browser > Open action
even if Microsoft Edge is your default browser.
Service Cloud case ID: 01799784

At bot runtime, when you assign a new window title to a window variable, the window variable now
detects the correct window.
Service Cloud case ID: 01788466, 01791773

You no longer encounter a compilation error in the UI in the following scenario:
1. Use the Datetime package released with Automation 360 v.23 or earlier to create a bot that

uses the Datetime > Assign action.
2. Then, select the Variable option to add the variable value.
3. Then run the bot with the package released with Automation 360 v.24 or later.
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You can now successfully capture objects from applications that are launched from a Citrix machine.

Nota:  This fix is available only with the new Automation 360 remote agent, which you can use
with the upgraded Recorder package (version 2.8.6-20220823-160834).

Service Cloud case ID: 00831939

When you assign a window title to a window variable, if the variable field has an empty regular
expression value, the bot no longer passes it without scrutiny. Instead, the following error message
is now displayed: Unable to find the window '<window_name>'. The provided
regular expression ‘<regular_expression>' is invalid. Please provide a
valid regular expression for the variable '<variable_value>’.

When you merge multiple PDF documents by using the PDF > Merge documents action, all the
form field attributes in Adobe Acrobat are merged and the output PDF document is now rendered
properly.
Service Cloud case ID: 01760279, 01792301

When you use the If > Folder does not exist condition to determine whether a folder does not
exist, if the specified folder exists, the bot now successfully recognizes the folder and does not
attempt to create it again.
Previously, because of the presence of leading and trailing spaces in the input folder path, the bot
failed to recognize an existing folder and hence attempted to create the folder, leading to an error.
Service Cloud case ID: 01466067

If you migrate a bot and select the HTML Tag, HTML InnerText, and HTML type properties
and then select HTML-type properties in Search Criteria, the bot now successfully locates and
identifies the object and performs the selected action.
Service Cloud case ID: 00829817, 01757049, 01761452, 01822711

When you use the Recorder package for the Get property action, the correct values are now
displayed for the top, left, height, and width properties.

Nota:  The Get property action does not display correct values for cross-domain iFrames
elements.

Service Cloud case ID: 01251758

The AISense Recorder package now works as expected when you use the Windows 10 operating
system in the Japanese language. Because UTF-8 is now enabled, you no longer need to use any
workaround.
Service Cloud case ID: 01821267, 01822433

When you use 2.8.0-20220601-034227 and later versions of the Recorder package, the automated
bot now returns the correct value for the HTML InnerText property in Google Chrome and Microsoft
Edge browsers.
Service Cloud case ID: 01257098 , 01754795, 01791073, 01787461, 01813080, 01846403

For WLM queues, the date is now displayed in the correct format as YYYY-MM-DD.
Previously, this date was shown in the years ago format, which did not match the date format in the
CSV file and was confusing.
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In a multitenant environment, when you upload a work item file to a queue in one of the tenants,
the In progress tab now displays the correct file upload status only in the corresponding tenant.
Previously, the In progress tab displayed the upload status for all the tenants.

When a WLM automation is in progress, an administrator can no longer delete the user who created
that automation.
Previously, the user who created an automation could be deleted, after which that automation could
not be paused or resumed by another user.

When you stop a WLM automation, work items are no longer stuck in the ready-to-run state and
are now moved to the New state.
Previously, when you stopped a WLM automation, a few work items were stuck in the ready-to-run
state and could not be deleted.

After you change any configuration field in the Administration > Settings > Devices >
Advanced options settings in versions prior to v.25, if the Control Room is updated to v.25, the
Global Cache Location is now set to the default C:/ProgramData/AutomationAnywhere/
GlobalCache value.
Previously, in such cases, no value was shown for the Global Cache Location field, which was
confusing.
Service Cloud case ID: 01869048

When you use the Run bot option to run a bot in the Activity > Historical > View page for any
activity, the bot now runs successfully.
Previously, in such cases, bot execution failed with an error.

When you import a bot that contains manual dependencies, for the overwrite option, the import
process now removes the manual dependencies.
Previously, during bot import, the manual dependencies were not removed for the overwrite option.
Service Cloud case ID: 01813452

When you import a bot into a folder, if a folder with the same name but different letter case already
exists in the repository, bot import now fails with an error.
Previously, in such cases, bot import was successful, but the imported bot failed at the time of
execution because of the wrong folder path.
Service Cloud case ID: 01270324, 01816507

You can now successfully access all the folders in the public workspace without any issues.
Previously, when you imported and cloned a bot under a folder in the public workspace and then
tried to access that folder, sometimes an error occurred, and the folder could not be accessed. This
occurred some times when there were more than 2100 folders under the bots directory.
Service Cloud case ID: 01852748

When you update from Enterprise 11 to Automation 360 or upgrade from an earlier version of
Automation 360 to a later version, the earlier defined group mappings are retained are retained,
even when the Distinguished Name (DN) column of the mapping entries are empty in the database.
Previously, some of the earlier-defined group mappings were deleted due to the empty value for the
DN column.
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After you update to Automation 360 v.22 or later, the Repository Management (v2/repository/file/
list) API now returns the correct file size as response output.
Previously, the Repository Management (v2/repository/file/list) API returned the file size as zero in
the response output.
Service Cloud case ID: 01151460

The Azul Zulu JDK is now updated to version 11.0.15+10. The previous version, 11.0.14+9,
contained some vulnerabilities.
Common Vulnerabilities and Exposures (CVEs) for this version are as follows: CVE-2022-34169,
CVE-2022-21540, CVE-2022-21541, CVE-2022-21549, and CVE-2022-34169
Service Cloud case ID: 01854652, 01868897, 01857973, 01854652, 01887083

Limitazioni

When you connect to the Microsoft Access Database with JDBC and specify the database path, and
if you use the following specific aggregation functions in the query, an error occurs when you run
the bot.

ASC, ATN, SQR, CBOOL, CCUR, CDATE,
CDBL, CDEC, CDATE, CDBL, CINT, CLONG, CLNG,
CSIGN, CSTR, CVAR, DATEADD, DATEDIFF, DATEPART,
DATESERIAL, DATEVALUE, FORMAT, IIF, INSTR, INSTRREV,
ISDATE, IsNull, ISNUMERIC, LEFT, LEFTS, LEN, MID,
MONTHNAME, DATE, NOW, NZ, SIGN, SPACE, STR, TIME, VAL,
WEEKDAYNAME, WEEKDAY, STRING, TIMESERIAL, CONCAT

Soluzione:
1. Go to Administration > Settings > Devices > Advanced options

> Bot launcher JVM options and set the value as follows: -
Dhsqldb.method_class_names=net.ucanaccess.converters*

2. Restart the Automation Anywhere Bot Agent service.

External key vault integrations are not supported on Oracle Database.

Not all missed recurring schedules are redeployed with the Redeploy the schedule again option.
Also, only one entry is shown for the missed recurring schedules in the In progress tab.

As an IQ Bot user, you can check out only the latest version of a process. You cannot check out
previous versions of a process because version check is performed based on the Automation
Anywhere file version and not the Git version.

The OAuth2 configuration settings in the Control Room will not enable you to connect to the
OAuth2 service at this time. Customers planning an OAuth2 integration with our partner application
should expect the service to be available by November.

In the Oracle Database environment, you cannot view a checked-in bot in the Public folder
because version check is performed based on the Automation Anywhere file version and not the Git
version.
Soluzione: To view a checked-in bot in the Public folder, you must refresh the Automation page
manually by using the Refresh button.
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In an Oracle Database environment, when you select the number format and sort order for the
work items in a queue, and then run bot using the Run bot with queue option, the queues are
not deployed. Also, no errors are shown in the Audit log or Activity page.

For regular or scheduled automations using the unattended Bot Runners, bot deployments remain
in the queued state and accumulate on the In progress page for these following scenarios:
• If the devices are down or not available.
• If a run-as user is busy executing the bot.

For devices not in the deployment state, if the number of queued bots reaches 500, it blocks the
bot deployments for all devices or for all run-as users.
Soluzione: To run the blocked deployments, perform one of the following actions:
• Select the queued jobs on the In progress page and move it to the Historical page
• Reconnect the Bot Runner devices.

When you set the default package version using the Update bots to default package version
option for bots in the public workspace that are using the Excel Advanced > Open action, the
TaskBots do not display the session name and file path values.
Soluzione: Perform one of the following workarounds:
• Update the Excel Advanced package manually to use the latest version of the package. Vedi

Select the package version used in your bot alla pagina 2015
• Check out the bot and revert to the previous version of the Excel Advanced package. Then,

check in the bot to use the latest version of the package. Vedi Aggiornamento dei bots alla versione
predefinita del package alla pagina 2651

Service Cloud case ID: 01905290, 01882083, 00712719, 00728499, 00737694, 00803673,
01255722, 00838604, 00772147, 01760236, 01762679, 01771416, 01761859, 01782588,
01778220, 01784255, 01789551, 01809167, 01818690, 01831969, 01813413, 01287311,
01923711, 01927867

You will encounter an error when you run a standard workflow in the SAP BAPI package
Soluzione: To execute SAP BAPI, use the Run Function call (RFC) with a combination of Create
function, Set or Get field value, Set or Get structure, and Set or Get table actions.

When you use 2.6.1-20220428-010714 or later versions of the Recorder package to automate a
web page on Microsoft Edge browser, the Recorder might not be able to perform Click or Left
click actions on the JavaScript alert, prompt, and confirmation pop-up windows.
Soluzione: For performing the click actions successfully, downgrade the Recorder package to
2.5.4-20220309-151830 version or earlier.

When you use the Browser > Close action to close a tab or a window opened in the Microsoft
Edge browser, if only one Microsoft Edge browser window is open, the bot encounters the following
error: Error occurred while closing the tab
Soluzione: Vedi Configure Microsoft Edge browser settings when Close action of Browser package
encounters an error (A-people login required)
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When you run a bot in the Google Chrome or Microsoft Edge browser, use the If, Loop, or Wait
action, select the webpage from the list of active tabs in the Browser tab, close the browser
window, and then run the bot, the bot might take two minutes to open the webpage in the browser
irrespective of the timeout value mentioned.
Soluzione: Move the If, Loop, or Wait action inside the If block and use the Application is
running condition with same browser application to check whether the browser is running.

When you run a stored procedure in Oracle and it returns SYS_REFCURSOR, the Run stored
procedure action is not closing the cursors. As a result, after the maximum cursor limit is reached,
this action results in an error.

When you migrate a bot that contains XML command > Get single node, after migration, the
bot encounters the following error: No node found at XPath while executing the Get
Single node command

Soluzione: If the XPath expression is not starting with (/) , apply XPath starting with “/“ so that
at the time of execution, the modification can be skipped or the XPath expression can be designed
to get the desired result.

While running a bot in debug mode, the bot will fail if the variable size gets greater than 3 MB. An
error message appears showing that a variable has exceeded the 3 MB limit.

When you use the Browser > Open action to automate a browser window running on Google
Chrome and Microsoft Edge browsers, then from the browser window, select More tools > Name
window option to update the title of this window during bot run and then when you try to run the
bot with the updated window title, the bot might fail.

When you use the actions in the App Integration package to extract text from a window, the bot
might not be able to detect the new UI of the Windows 11 operating system and capture the text.
Soluzione: Enable the old classical UI in Windows 11 operating system. Vedi  Restore Old Classic
Notepad in Windows 11

When you use the /v2/repository/file/list, the response lists bots restricted by user
role. If you use this API as an AAE_Admin, you can view bots from the private repository in the
response. Whereas if you use this API as a bot creator, you can view system bots (recorder) in the
response.
Soluzione: Use the /v2/repository/workspaces/{workspaceType}/files/list.

Command prompt API allows you to switch the device registration even if the Allow devices
(single user) to be switched to another Control Room without reinstalling bot agent
option is disabled.

When you upgrade from Automation 360 v.25 to a later version, although you enabled code
analysis in the Control Room, the rules set in the policy are not retained after the upgrade.
Soluzione: Before upgrading, we recommend that you keep a note of the rules enabled in
Automation 360 v.25 and then re-enable them after upgrading to a later version.

Feature deprecations

Review features and capabilities (from Automation Anywhere or other third-party vendors) that are
deprecated or nearing deprecation to understand how they impact your automation.
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Automation Anywhere Mobile app deprecated
The Automation Anywhere Mobile app is deprecated as of July 2022 and will not be updated to
subsequent versions of iOS and Android. The mobile app is no longer available and no further
support will be offered. A replacement product is currently not available.

Tesseract OCR v3 deprecated
Tesseract OCR version 3 is deprecated as of September 2022. If you have created learning
instances using Tesseract OCR version 3, we recommend that you plan to train your learning
instances with alternative OCRs (including Tesseract4 OCR) before you update to Automation 360
v.26.
Deprecation of Tesseract OCR v3 alla pagina 820

Deprecation of IQ Bot Extraction package
The IQ Bot Extractionpackage has been deprecated as of September 2022. As part of Automation
360 v.26, IQ Bot will no longer support pretrained machine learning models for invoice data
extraction.
To move your bots from the IQ Bot Extraction package to Document Automation, see IQ Bot
Extraction package alla pagina 1654.

RPA Bots for Excel deprecated
RPA Bots for Excel has been deprecated as of January 2022. The plug-in is no longer available to
download as a product. However, support will be offered to current customers already using the
product.
A replacement product as a plug-in for Microsoft Excel is not available. In RPA Bots for Excel, this
action was triggered from within the Excel application. However, as an alternative, new customers
can develop bots for Excel within Automation 360 RPA Workspace and use input variables to allow
specifying file names, worksheets, and ranges for bots to operate on. In RPA Bots for Excel, this
action was triggered from within the Excel application, whereas now this action is taken from the
Automation Anywhere Control Room.

G-Suite Apps package deprecated
The G-Suite Apps package has been deprecated as of September 2022 and it no longer supports
using the Connect and Disconnect actions to establish a connection with the Google server and
automate tasks.
Azione consigliata: For specific G-Suite applications, the functionality of the G-Suite Apps
package is available in the following G-Suite packages:
• Google Drive
• Google Calendar
• Google Sheets

To automate tasks, in the appropriate G-suite package, use the corresponding Connect and
Disconnect actions.

Concetti correlati
View package versions available in the Control Room alla pagina 2009
Actions are grouped into version-specific packages. Bot Creators can select which package version to use
for a specific bot.
Riferimenti correlati
Note sulla versione Automation 360 v.26 alla pagina 171
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Updating to v.26 release alla pagina 196
Review requirements and support information about updating your Control Room and Bot Agent for the
v.26 release.
Migration updates for v.26 release alla pagina 197
Review what's new, changed, and the fixes and limitations to migrating from Enterprise 11 and 10 versions
to Automation 360 v.26.
AARI v.26 release alla pagina 202
Review what's new and changed and the fixes in AARI for the v.26 release.
IQ Bot and Document Automation v.26 release alla pagina 204
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.26 release.
Bot Insight v.26 release alla pagina 211
Review what's changed and the limitations in Bot Insight for the v.26 release.

Updating to v.26 release
Review requirements and support information about updating your Control Room and Bot Agent for the
v.26 release.

Aggiornamento Control Room

If you are updating to this release, ensure that the Server audit is not enabled on SQL Server Database.
If the server audit is enabled, use SQL administrator user account to turn off the SQL Server audit before
initiating the update.

Aggiornamenti Bot Agent

Importante:  Questa versione include un aggiornamento di Bot Agent facoltativo. You can continue to
run your existing bots without updating the Bot Agent. However, if you want to use the new features in
Automation 360 v.26, you must update the Bot Agent available with this release.

Per informazioni sull'aggiornamento a questa versione, consulta le seguenti risorse:
• Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina

1043
• Compatibility with release builds alla pagina 1026

Supported Control Room builds for direct update

You can update to the latest version of Automation 360 from the previous three releases (that is, from n−3
releases, where n refers to the latest release).
The following previous releases are certified for update to Automation 360 v.26:
• v.25 (Build 15112, 15097)
• v.24R2 (Build 13343), and v.24 (Build 12350, 12342)
• v.23 (Build 11513)

If you are on one of these previous releases, for information about updating, see Aggiornamento
alla versione di Automation 360 più recente alla pagina 1063. If you are not on an n−3 release, update
Automation 360 to one of the n−3 releases before updating to Automation 360 v.26.

© 2023 Automation Anywhere. All rights reserved.     196



    Automation Anywhere - Learn

Per gli aggiornamenti più recenti delle estensioni di Automation 360 per Google Chrome, Microsoft Edge e
Mozilla Firefox, vedi Browser extensions for Automation 360 alla pagina 718.
Riferimenti correlati
RPA Workspace v.26 release alla pagina 178
Review what's new and changed, fixes and limitations, and the feature deprecations in RPA Workspace for
the v.26 release.
Migration updates for v.26 release alla pagina 197
Review what's new, changed, and the fixes and limitations to migrating from Enterprise 11 and 10 versions
to Automation 360 v.26.

Migration updates for v.26 release
Review what's new, changed, and the fixes and limitations to migrating from Enterprise 11 and 10 versions
to Automation 360 v.26.

Novità

Enterprise 11 e Enterprise 10

Migrate parent bots independently, avoiding overwrites and loss of updates (Service
Cloud case ID: 01258572, 01778107, 01275417, 01880168)
You can now migrate a parent bot independently even if it has associated child bots. You now
have a choice to select whether you want to migrate a parent bot independently or along with its
dependent child bots.
This helps in avoiding overwrites and loss of updates that might happen when child bots that are
migrated to Automation 360 are updated after migration.
Migrazione dei bots di Enterprise alla pagina 1216

Migrate more bots with specific features
You can now successfully migrate bots in the following cases:
• Bots that use spreadsheets residing in SharePoint by using the Excel advanced > Open

action.
• You can now migrate bots with REST commands with custom proxy configuration at the Action

level. For custom proxy configuration support, in the Bot Migration Wizard, select the
Include web service settings option.
When you select this option, the REST commands are migrated with custom proxy
configurations that use the following global variables:
• AAProxyHost for Hostname
• AAProxyPort for Port

Migrazione dei bots di Enterprise alla pagina 1216
• Bots in which the user interface or window extends beyond the screen on the top-left corner

(truncated) for the following actions: Object Cloning, If, Loop, Web Recorder, and Manage Web
Control.
Now, migrated bots support windows with negative coordinates (truncated windows).
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Enterprise 11 only

Migrate bots independent of Bot Insight migration
Before migration of legacy bots, you can now declare whether these bots were using the Bot
Insight option in Enterprise 11 by selecting the Tag bots and variables for analytics option in
the Bot Migration Wizard. The Bot Insight Open and Close actions are created only for such
migrated bots where this option is selected.
Migrazione dei bots di Enterprise alla pagina 1216

Cosa è cambiato

Assess migration readiness of processes with Bot Scanner
The Bot Scanner scans your repository for processes that can be migrated to Automation 360 and
provides information under the following categories:

Nota:  A process is a bot that is not used in any other bot and can include child bots.

• Tutti: List of all the processes.
• Action required: List of processes that require action after migration to Automation 360. A

process is flagged as Action Required even if one of its child bot requires action.
• Review required: List of processes that require review after migration to Automation 360. A

process is flagged as Review Required even if one of its child bot requires review.
• No review required: List of processes that can be migrated. All the bots in the process can be

migrated.
• Non Migratable: List of processes that cannot be migrated. All the bots in the process cannot

be migrated.

Nota:  For generating processes summary report, the maximum repository size that is supported is
up to 10 GB.

Analisi del report di Bot Scanner per la migrazione alla pagina 1162

Direct link to upgrade launchpad and migration resource portal in Bot Scanner
Bot Scanner report now also contains direct links to:
• Upgrade Launchpad: Use the information provided on this page for a self-guided experience that

is customized for your migration requirements.
Upgrade Launchpad

• Enterprise Migration Resources: Use the information on this page to plan for migrating to
Automation 360.
Enterprise Migration Resources | Cloud RPA | Automation Anywhere

Analisi del report di Bot Scanner per la migrazione alla pagina 1162

Direct link to corresponding migration messages
With a direct link to migration messages in Bot Assistant, you now have quicker access to
information about migrated bots that require action or review.
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Validate letter case in window titles
You can now validate the letter case in window titles in window variables. By using the Case
sensitive option, you can now decide whether to match or not match the letter case in window
titles that have the same titles but differ in letter case.
With this option, you can ensure that the migrated bots produce the same output as that of their
corresponding Enterprise 11 bots.

Review bots more efficiently with exact line number in Bot Scanner report
The Bot Scanner report now displays the exact line number in the bots that need review or
action even in cases where some of the commands used in Enterprise 11 bots are not available in
Automation 360.

Correzioni

When you migrate bots with the Select item by index action of the SAP package, the index is
now displayed correctly. The migrated bot selects items according to the correct index, and no error
is displayed.

MetaBots that were captured using the following configurations will now be migrated to Legacy
AISense in Automation 360:

Linked object play mode Main object play mode

Testo Testo

Nessuno Testo

Previously, bots that used such MetaBot configurations failed to migrate.
Service Cloud case ID: 01774261

You can now migrate TaskBots that use MetaBot Logic whose DLL file contains classes without a
namespace.
Previously, an error occurred when you ran such TaskBots.
Service Cloud case ID: 01765712

When you migrate from Enterprise 11 to Automation 360, capturing MetaBot screen commands is
changed as follows:

Enterprise 11 Automation 360

• Main objects captured with the Object play
mode

• Linked objects captured with the
Coordinate play mode

Record capture actions with the Object play
mode
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You can now use commas in the filenames of bots that use FTP actions and use colons in the
filenames of bots that use Delete files and Delete folder FTP actions.
Previously, such bots encountered an error during bot run.
Service Cloud case ID: 01772186

When you migrate bots that use the same window titles but have different letter case in window
variables, the bots now run successfully.
Previously, bots that used the same window titles but had different letter case in window variables
failed to run successfully after migration.
Service Cloud case ID: 00825181

You can now successfully run migrated bots that use the Email Received Date variable twice in
subactions inside the Email Loop action.
Previously, a parse error occurred in such cases.
Service Cloud case ID: 01275815

In migrated bots, when you use the Recorder package, you can now use the Click action on Client
Control in HTML technology without any issues.
Previously, the Click action button on Client Control did not work as expected.
Service Cloud case ID: 01713357

You can now successfully re-edit a migrated bot with the Record > Dataset variable.
Service Cloud case ID: 01807170

When you want to open web pages, in the Browser package, when you use the New window
option of the Open action, you can now specify a URL without the protocol information, such as
http, https, or file.
Previously, when protocol information was not provided in the URL, some web pages did not open
properly.

You can now successfully migrate Enterprise 11 bots with analytics flags.
Previously, migration failed when variables with analytics flags were checked.
Service Cloud case ID: 01768545

When you click the Back button in the migration details page for a migration run, you are now
redirected to the Migration runs tab.
Previously, when you clicked the Back button, you were redirected to the Overview tab.
Service Cloud case ID: 01816558

When you migrate a bot that uses the Manage Window Controls action, the height value is now
set correctly after migration.
Previously, after migration, the last digit of the height value was not available.
Service Cloud case ID: 01756996
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When you run a bot to automate spreadsheet data, all the requests are now processed successfully
in the following scenario:
When an Excel session is active in SAP and a corresponding Excel process starts in the background,
Automation 360 creates a separate Excel process other than the one that SAP started, and the
correct window is now activated for all the subsequent requests.
Previously, only the first request was processed successfully because the correct window was not
activated for automating the spreadsheet data for the subsequent requests.
Service Cloud case ID: 00815159

When you migrate bots from Enterprise 11, the automation priority of each bot is now adjusted to
match its equivalent priority level in Automation 360, as follows:
• In Enterprise 11, if the automation priority for a bot was set to low, after migration, the

automation priority for the bot is changed to medium.
• In Enterprise 11, if the automation priority was set to medium, the automation priority in the

migrated bot is set to high.

Nota:  There is no change in automation priority when it is set to high.

Previously, the automation priority of migrated bots remained the same as in Enterprise 11.

You can now migrate bots even if the properties value of the Manage Window Controls action is set
to 65536 or more.
Previously, when the properties value was set to 65536 or more, the bots encountered an error
during bot run.
Service Cloud case ID: 01768555, 01825071

After migration, you can now get all the lines of text from the Terminal Emulator by using the Get
text > All lines action.
Previously, you could get only 24 lines of text from the Terminal Emulator.
Service Cloud case ID: 01609467

In the Bot migration wizard, the Bot Scanner and the Bot migration report now display the correct
status for bots that are flagged for the R134 migration message.
Previously, in the Bot Scanner and the Bot migration report, the status of bots that required review
was incorrectly displayed as No review required.

You can now successfully migrate bots whose queue category name contains a space.
Previously, migration of such bots failed because Enterprise 11 bots whose queue category name
contained a space went into an infinite loop until the loop timed out at 90 minutes.
Service Cloud case ID: 01850864

After you migrate a bot that uses the Terminal Emulator package, when you run the bot, the
terminal window is now activated and remains in the front. This is because the Show terminal
window in the front option in the Connect action is now enabled by default.
Previously, when you ran such a bot, the terminal window was not activated and remained
minimized because the Show terminal window in the front option was not present in the
Connect action.
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When you run a bot with the Database package, the bot no longer becomes stuck at the Insert or
the Update command when run for a long duration.
Previously, in such cases, the bot became stuck intermittently.
Service Cloud case ID: 01836733

Limitazioni

In Enterprise 11, if bots were using the String > Replace action to find a carriage return line feed
(CRLF) character and replace it with another character, after migration, the output might not be the
same as the output seen in Enterprise 11.
Soluzione: In the Find string option, instead of the Enter (LF) variable, use the Newline (CRLF)
variable.
Service Cloud case ID: 01808878

In Enterprise 11, if bots were using the If, IF/ELSE, or Loop While command in Windows Control
and if the Application window does not exist, after migration, the bots will encounter an error
during bot run.
Service Cloud case ID: 01846262

When the Select query is used inside a Loop command and its result set is further iterated, if the
query returns no record, the result set Loop reiterates the previous record.
Service Cloud case ID: 01799961

Riferimenti correlati
RPA Workspace v.26 release alla pagina 178
Review what's new and changed, fixes and limitations, and the feature deprecations in RPA Workspace for
the v.26 release.
Updating to v.26 release alla pagina 196
Review requirements and support information about updating your Control Room and Bot Agent for the
v.26 release.

AARI v.26 release
Review what's new and changed and the fixes in AARI for the v.26 release.

Novità
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Embedded automation with OAuth 2.0
Embedded automation streamlines access to the automation experience.
Embedded Automation alla pagina 2218
• AARI Integrations embeds in web applications as a widget, so if you are an end user, you can

access automated processes and bots without leaving your environment.
• AARI Extensions offers further adaptability through Chrome browser extensions, enabling

automation directly in any web scenario. Business users can now access automations through a
widget, available through an extension in their web browser.

• With an OAuth 2.0 connection, existing access to automations in the Control Room are now
shared with the Extensions to offer you a seamless user experience.

AARI Integrations e AARI Extensions alla pagina 2221

Oracle Database support
We now support AARI on Oracle Database. When you install or update to this release, you can now
choose Oracle Database to work with AARI.

Delete files permanently from AARI cloud storage
You can now delete files permanently from AARI cloud storage. When you delete a request, the
associated file is also permanently deleted now and not just sent to the recycle bin.
Cloud storage usage alla pagina 2130

Append or overwrite operations in your form
Append or overwrite operations in your form by using the Assign form rules for the web, with the
Checkbox and Radio Button elements, which now support form rules.

Assign dynamic values with support for new elements in your forms
When you use the interactive forms package, you can now assign dynamic values with the Assign
action, which now supports Checkbox and Radio Button elements in your form.
You can also change the label of the selected form elements with the Change label action for the
Button element.
Interactive forms package alla pagina 1638

Run processes more seamlessly by setting expiration time for human tasks (Service
Cloud case ID: 00806522)
You can now run your process more seamlessly even when a human task takes longer to run. You
can achieve this by setting an expiration time for your tasks in Human Task in a process.
When you set an expiration time, if a human task takes longer to address, the task times out and
the process moves to the next step to ensure there is no break to the flow.
You can set the expiration time by number of days, hours, and minutes, depending on your
requirement.
Crea un processo AARI alla pagina 2133
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Cosa è cambiato

Simplify your workflow by grouping multiple conditions in form rules
You can now group multiple conditions for your form rules by using the And logic with the Or logic.
Previously, you could group only the And logic or the Or logic. This change, which is similar to the
If-Then-Else logic, facilitates grouping multiple conditions and helps simplify your workflow.

Correzioni

You can now have greater security validation because it is no longer possible to upload files that
have double extensions, such as File.PDF.PDF, to your web application.
Previously, uploading files with double extensions was possible, which represented a significant risk
to applications.
Service Cloud case ID: 00828289

Repetitive error messages do not appear in logs. Clean up operations now include recursive request
files to prevent spam in audit logs.
Service Cloud case ID: 01816489, 01839604

When you use the Has Errors rule to show the number of errors in your form, the error message
now shows the correct number of errors.

When you update from Automation 360 v.24R2 to Automation 360 v.25, the bot setup now correctly
shows the number of bots and assigned teams.

Riferimenti correlati
Note sulla versione Automation 360 v.26 alla pagina 171
RPA Workspace v.26 release alla pagina 178
Review what's new and changed, fixes and limitations, and the feature deprecations in RPA Workspace for
the v.26 release.
IQ Bot and Document Automation v.26 release alla pagina 204
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.26 release.
Bot Insight v.26 release alla pagina 211
Review what's changed and the limitations in Bot Insight for the v.26 release.

IQ Bot and Document Automation v.26 release
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.26 release.
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Document Automation

Novità

Improve extraction by providing changes to the Validator
You can now improve extraction by providing learning instances with validation feedback for
Automation Anywhere models. You can achieve this by enabling the Validation feedback option
in the Create learning instance and Edit learning instance windows.
Data extraction in Document Automation alla pagina 2570

Search for form or table fields
When creating a learning instance, when you are configuring fields, you can now search for fields
by field name, field label, or data type.

Process invoice-like documents with user-defined document type
You can now process documents that are visually similar to invoices, such as purchase orders and
sales orders, which contain key-value pairs and a table structure. You can achieve this by create
learning instances with the user-defined document type, using which you can also achieve the
following results:
• Extract from English, Dutch, French, German, Italian, Portuguese (Brazilian), and Spanish

language documents.
• Define exactly which values to extract from a field, such as when a date of birth field also

contains the age.
• Use the Address data type for form fields, which identifies and extracts the structure of an

address.

Miglioramenti al Validator
• The Validator now shows the group number for documents processed in a learning instance

connected from Automation 360 IQ Bot
• You can now configure a list of valid values when creating learning instance.
• When you click a field that requires validation, a message now appears with the confidence level

determined by the system and the threshold set in the learning instance.

Monitor document processing metrics in Bot Insight dashboards
You can now visualize data, such as the number of documents uploaded per day, extraction
time per document by learning instance, and STP percentage by learning instance, by using the
customizable dashboards in the Document Workspace tab.
Document Workspace dashboard alla pagina 2963

Document Automation now supports the bring your own key (BYOK) use case for the
Google Document AI product license
Users can now configure their Control Room environment with Google Document AI licenses
purchased from Google. This allows the learning instance to send documents to Google Document
AI for extraction and for the Control Room to track consumption in the All licenses page.
Configure key for Google Document AI alla pagina 2566 | Licenze Automation 360 alla pagina 1010
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Novità

View Document Automation user activities in the audit log
With the AAE_Admin role or a custom role with the View audit log permission, you can now
view the status of events related to learning instances, domains, and documents.
Log di audit alla pagina 2654

Create and train standard forms within the Control Room
Users with the AAE_IQ Bot Admin or AAE_IQ Bot Services roles can now create new standard
forms in Document Automation. It is no longer necessary to leave the Control Room and open a
third-party service to create or modify a standard form. The interface to configure the extraction
model is launched from the Learning instances page.

Nota:  To process documents in a learning instance which uses the standard forms model in
Document Automation:
1. Create the standard form in Document Automation.
2. Create and train the learning instance in Automation 360 IQ Bot.
3. Connect the learning instance to Document Automation.

Create standard form in Document Automation alla pagina 2603

Cosa è cambiato

To connect a learning instance from Automation 360 IQ Bot, you must have one of the following
roles:
• AAE_IQ Bot Admin
• AAE_IQ Bot Services
• Un ruolo personalizzato con l'autorizzazione Connetti l'istanza di apprendimento

Uploaded documents and extracted data are now removed after 90 days even if a document has
not completed processing, except in the following cases:
• If data is downloaded and deleted, the source documents are immediately deleted.
• If the document is manually validated, the document is stored for 90 days from the date of

extraction.

If a document is renamed to a new file extension and uploaded to a Google Document AI
pretrained model, the document will fail processing.
Soluzione: Rename the document to the correct file extension.

Correzioni

Beside the Validate documents link, the value that reflects the number of documents awaiting
validation is no longer hidden, and you can now view it without adjusting the width of the Actions
column.
Previously, you had to adjust the width of the Actions column to see the value.
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Correzioni

You can now successfully draw a box, zoom in, fit the box to match the screen size, and then
redraw the box without any issue.
Previously, when you drew a box, zoomed in, clicked Fit to screen, and then tried to redraw the
box, the box appeared at a different location from where you clicked.

In the Validator, you can now adjust the system-identified region (SIR) by dragging the corners of
the SIR when you zoom in or zoom out.
Previously, you could drag the corners of the SIR but not when you zoomed in or zoomed out.

When you connect to a learning instance from Automation 360 IQ Bot, if the learning instance has
an optional field with a set default value and some fields that are unmapped, when you process
documents in that learning instance in Document Automation, the default value now appears only
in the mapped fields.
Previously, the default value appeared incorrectly in the unmapped fields.

In Community Edition, when you try to delete a learning instance, the following, correct message
is now displayed and you can successfully delete the learning instance: Community edition
 users are limited to 5 learning instances

Previously, although you could delete the learning instance, the following, incorrect message was
displayed: Community edition users are limited to 5 learning instances and
 will not be able to delete.

Fixed an issue where Document Automation sometimes failed to extract data from tables that span
across multiple pages. Document Automation now supports data extraction from tables that span
across multiple pages for Automation Anywhere models.

You can now use the Document Extraction > Download action in a standalone bot that is not
part of an AARI process.
Previously, this action could be used only in the Downloadbot within the AARI process that was
automatically generated when a user created a learning instance.

After the Validator times out because of inactivity, when you refresh it, instead of showing the most
recent document that you validated, the Validator shows the first document that you validated.

Limitazioni

Document Automation does not support Cloud-enabled (SDS) deployment.

Formula validation does not support numbers that contain delimiters. For example, 1,000 and 2.0
are not supported.

In alcuni casi, Bot Agent non cancella la cartella delle risorse. Finché lo spazio su disco non sarà
liberato, i documenti di produzione in elaborazione ne risentiranno. Questo problema si verifica a
intermittenza.
Soluzione: In base al problema, devi creare un'attività di pianificazione per ripulire la cartella delle
risorse ogni giorno o settimanalmente.

There is no notification when the product license is about to expire. Quando la licenza del prodotto
scade, la scheda Istanze di apprendimento viene rimossa dalla Control Room.

Learning instances that use Google Document AI models do not reliably extract all the fields in a
table, if the table that spans multiple pages.
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Limitazioni

In On-Premises installation in Linux environments, document processing sometimes fails because of
a storage service error.
Soluzione: In the command prompt, run the following script:

cd /opt/automationanywhere/automation360/appdata/Server Files/
sudo chown -R crstorage:controlroom storageservice

Document Automation does not support Oracle Database for On-Premises installations.

Document Automation supports only the following standard ports for On-Premises installations:
• For HTTP: Port 80
• For HTTPS: Port 443

Sometimes, files uploaded to train a standard form appear corrupted although the data is still
usable.

Standard forms in Document Automation is not supported in a multi-tenant Cloud Control Room
that was upgraded from v.25. This limitation does not occur on a fresh installation of a multi-tenant
Cloud Control Room.

Learning instances with the user-defined document type do not support Dutch language
documents.

The first time you click a learning instance connected from Automation 360 IQ Bot, you are
redirected to the IQ Bot homepage instead of the details page for that learning instance.

Formula validation is not supported for custom fields if the field name contains a space.

When you import a learning instance created in a previous version of Document Automation, the
check box to send validation feedback to the system is unselected by default. You must edit the
learning instance to select the check box.

Document Automation does not perform post-processing on connected learning instances that
contain Python custom logic with either of the following:
• Single quotes, such as print('Test'). Ensure the Python script uses only double quotes.
• Characters from non-Latin languages (Unicode characters), such as äöüñй.

Formula validation is not supported in learning instances with the user-defined document type.

When you process documents using the IQ Bot Extraction package, the Python scripts are not
applied properly on the form fields for the classic learning instances connected on Document
Automation. This results in improper data extraction in the output CSV files and the Validator.

When you click the Table icon on Form OCR Testing Tool (FOTT) editor, the text appearing on the
pop-up window is not readable.

If IQ Bot,Control Room, and Bot Agent are installed on the same Windows Server 2012 , then data
extraction fails for any Classic learning instances connected in Document Automation.
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IQ Bot

Novità

When user logs out, lock released immediately on documents in Validator
When a user logs out of IQ Bot, the lock on the documents in validation is now released
immediately so that other users can view or validate the documents. Previously, when a document
was in the Validator queue, if the logged out, the lock on the document in the validator was not
released immediately, as a result of which other users could not view or validate the document.
Use the IQ Bot Validator alla pagina 2530

IQ Bot Database Migration Assistant Tool now supports Windows Authentication
When you migrate from Enterprise 11 to Automation 360 by using the Database Migration Assistant
Tool, you can now use Windows Authentication for connecting to the IQ Bot database server.

Choose classification type while creating learning instance
When you create a learning instance, you can now choose which aliases and fields are considered
for classification by using the Disable classification changes on domain modification (fields,
alias) check box.
• When this check box is selected, the classification process uses only the aliases or fields that

were present in the domain when the learning instance was created. Aliases and fields added to
the domain after the learning instance was created are not considered for classification.

• When this check box is cleared, the classification process uses all the aliases or fields that are
part of your domain. Aliases and fields added to the domain after the learning instance was
created are also taken into consideration for classification.

This feature classifies the document to the same group even if there are any updates in the
domain.

Cosa è cambiato

Upgraded machine learning models
IQ Bot now uses an upgraded machine learning model for detection of check boxes and Advanced
tables.

Python libraries upgraded to 64-bit
All the Python libraries provided in IQ Bot by Automation Anywhere for this release are now
upgraded to 64-bit from 32-bit. If you are using third-party libraries, ensure that you upgrade
to 64-bit libraries. After upgrading the third-party libraries, ensure that these libraries work
successfully.

Correzioni

When you download an unclassified document, click Delete from the server, and then toggle
the learning instance from production to staging and back, the document no longer appears in the
untrained folder. Previously, when you downloaded an unclassified document from the untrained
groups, even after you deleted it, the document still reappeared in the folder.
Service Cloud case ID: 01781935
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Correzioni

When you upload documents, the Classifier no longer halts or becomes stuck. Documents that
are not classified are now cleared from the queue, allowing smoother processing of subsequent
documents. If these documents fail to be processed within the timeout limit, they are now
categorized as unclassified and you can download these unclassified documents.
Service Cloud case ID: 01762844, 01272642, 01750753

You can now install IQ Bot by using Windows authentication and CyberArk Vault and then rotate
the key. Previously, when you tried to rotate the Vault key, the following error message was
displayed: Si è verificato un errore durante l'impostazione della nuova
chiave. Controlla i registri

You can now select multiple learning instances for backup by using the Search drop-down list.
Previously, after you clicked the Create Backup option on the Migration Management page,
if you selected a learning instance and then used the Search drop-down list to select another
learning instance, the previously selected learning instance became deselected.

The value displayed in the My totals > Accuracy field now matches the value in My learning
instances > Field accuracy for the available learning instances.

You can now add documents to manually created groups and upload documents to staging.
Previously, when you edited a manually created group or tried to upload a document, you
encountered an error and the following error message was displayed: Failed to update
 manual group: Duplicate label found.

Service Cloud case ID: 01849616, 01845590

You can now use the migration utility to successfully migrate learning instances created for
a custom domain. When you import IQBA files with duplicate fields (even through an API),
the following message is displayed alerting you to the existence of duplicate fields: Error:
 Duplicate field found Invoice number. Previously, the migration utility could not be
used to migrate learning instances created for a custom domain.
Service Cloud case ID: 00729627

During migration, you can now successfully import and export IQBA files. Previously, the import
and export of IQBA files failed because the content classification table contained duplicate training
fields.
Service Cloud case ID: 00826891

When a document is successfully downloaded, it is now placed in the Success folder. Previously,
documents that were successfully processed were sent to the untrained folder, causing
inconsistencies in the download process.
Service Cloud case ID: 00780227,00842077

When there is an update in the domain, IQ Bot now classifies a document to the same group.
Previously, whenever there was any update in the domain, IQ Bot created new groups for the same
document.
Service Cloud case ID:01622981

If a document without content is uploaded to a learning instance in production, the following
message is logged in the bot_launcher.log file: Unable to upload file <filename> to the
 Learning Instance. No content in file, size 0" whenever there is a 0 KB
 file is uploaded.
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Correzioni

The security vulnerability related to Unquoted Service Path has been fixed. Previously, the
Windows host referred to an installed service that used an unquoted service path containing
whitespace Automation Anywhere Cognitive Console: D:\Program Files (x86)\Automation
 Anywhere IQ Bot\Portal\node modules\winser\bin\nssm64.exe, which resulted in
the vulnerability.
Service Cloud case ID:01880370

Limitazioni

You cannot create a bot in IQ Bot when an invalid document is uploaded to a custom or manual
group. Also, when an invalid document is uploaded along with a valid document and processed for
extraction, the See extraction page keeps loading.

IQ Bot does not support Oracle Database for on-premises installations.

During production processing, if a learning instance is switched from Production to Staging or the
other way around, for any documents processed during this switch, the production document that
appears in Validator is blurred and not in human-readable form.

IQ Bot does not perform post-processing on a field if the custom logic uses Python script containing
single quotes, such as print('Test'). Ensure the Python script uses only double quotes.
Custom Logic Python script challenges in A360.26 IQBot (A-people login required)

If your IQ Bot custom logic uses the Pandas library, the script must have the import Pandas
statement.

IQ Bot does not perform post-processing on a field if the custom logic uses Python script containing
characters from non-Latin languages (Unicode characters), such as äöüñй.

In IQ Bot, when you run a script created on versions prior to Automation 360 v.26, you might see a
warning. However, this does not impact the script execution and the functionality.

Riferimenti correlati
Note sulla versione Automation 360 v.26 alla pagina 171
RPA Workspace v.26 release alla pagina 178
Review what's new and changed, fixes and limitations, and the feature deprecations in RPA Workspace for
the v.26 release.
AARI v.26 release alla pagina 202
Review what's new and changed and the fixes in AARI for the v.26 release.
Bot Insight v.26 release alla pagina 211
Review what's changed and the limitations in Bot Insight for the v.26 release.

Bot Insight v.26 release
Review what's changed and the limitations in Bot Insight for the v.26 release.
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Cosa è cambiato

With the expanded user interface, you can now gain more insights into the Document Workspace. A
new dashboard is available that delivers insights to Document Automation activity and trends, such
as number of uploaded documents, pages and average extraction time. See more information in the
following topic.
Document Workspace dashboard alla pagina 2963

Limitazioni

DataTable widgets for Bot Insight dashboards currently show a maximum of 100 records.
Service Cloud case ID: 01820004, 01851999, 00760252, 00806950

To avoid errors from occurring during bot lifecycle management, the private workspace dashboards
will be imported only when the bot is imported directly to the private workspace.
Importing a bot to the public workspace and checking the bot out to the private workspace will not
import the associated private workspace dashboards.
Service Cloud case ID: 00760022, 01803726, 01794757, 01777561, 01780407, 01842554,
01874606

Connectors for Bot Insight, such as Tableau or Power BI, work only with the following
authentication mechanisms:
• Authentication based on Control Room database
• Authentication based on Active directory

Service Cloud case ID: 01863601, 01909212

Riferimenti correlati
Note sulla versione Automation 360 v.26 alla pagina 171
RPA Workspace v.26 release alla pagina 178
Review what's new and changed, fixes and limitations, and the feature deprecations in RPA Workspace for
the v.26 release.
AARI v.26 release alla pagina 202
Review what's new and changed and the fixes in AARI for the v.26 release.
IQ Bot and Document Automation v.26 release alla pagina 204
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.26 release.

Note sulla versione Automation 360 v.25
Data di rilascio: 28 June 2022

Riesaminate le novità e le modifiche apportate e le correzioni e le limitazioni della Automation 360 versione
v.25.
• Control Room: Cloud Build 14304 (replaces Build 14298) and On-Premises Build 15112 (replaces Build

15097)
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• IQ Bot: Cloud Build 14304 (replaces Build 14298) and On-Premises Build 15112 (replaces Build 15097)

Importante:  Manifest V3 based extensions - Google will deprecate Manifest V2 based extensions
for Google Chrome by January 2024. . To know about Microsoft Edge Manifest V2 based extensions
timelines, see Overview and timelines for migrating to Manifest V3. The deprecation might impact your existing
automation that use current Manifest V2 based extensions in Google Chrome and Microsoft Edge browsers.
Use the Automation 360 v.25 Build 15118 and Bot Agent version 21.211 for the latest Manifest V3 based
extensions updates to support features that use Google Chrome and Microsoft Edge browsers. This build is
available for download in the link provided in the following article: Everything about the Chrome/Edge Manifest
V2 Deprecation. Consulta Chrome and Edge Manifest V3 extensions alla pagina 807 e Everything about the
Chrome/Edge Manifest V2 Deprecation.
If you want to continue using the earlier builds of Automation 360 v.25 (Build 15112 or 15097) but want
to upgrade to Manifest V3, you can manually upgrade to Manifest V3. Consulta Manifest extension manual
upgrade.

Importante:  We have updated the Cloud Build 14304 and On-Premises Build 15112 to include fixes for
the following issues. Fixes specific to On-Premises or Cloud builds are indicated.
• When you created or deleted new users, multiple, duplicate audit log entries were generated for a

single user (Service Cloud case ID: 01836296).
• When you logged in to the Control Room with bot export permissions, when you exported a task, no

corresponding entry was immediately visible in historical activity (Service Cloud case ID: 01834139,
01839933, 01841993, 01839817, 01834108, 01846407, 01845706, 01843349, 01846220, 01846819,
01845547, 01847028, 01847024, 01847094, 01847114, 01847115, 01846998, 01847840, 01846757,
01848123,01846944, 01848104, 01848294, 01848905, 01846596, 01849748).

• When you updated to Automation 360 v.25 and attempted to use the previous settings with instance
names, the previous settings were not allowing an update (Service Cloud case ID: 01838276,
01835897).

• (On-Premises only) When you deployed a task On-Premises without direct Internet access, the
compilation slowed down (Service Cloud case ID: 01841448, 1839118, 1844817, 01846153, 01846332,
01839254).

• When the wait for condition package was used with any command package, the set timeout value for
the wait was not met (Service Cloud case ID: 01842547, 01846156, 01847338, 01846324, 1842368,
01847054, 01848080, 01848789, 01848151, 01848963, 01847054, 01847121, 01848236, 01848260,
01849016, 01848248, 01848572, 01847828, 01847055, 01848826, 01848191, 01848944, 01851181,
01849792, 01852057, 01846152).

• When you update from any build to Automation 360 v.25, if changes were made to the If/Else logic
in nest and saved, a new Go to End point element was added, which created a process error (Service
Cloud case ID: 01848192).

• (On-Premises only) When an AARI process was checked in and then checked out, the mapped variables
did not persist and were lost (Service Cloud case ID: 01847675).

This page includes the following sections:
• Migrazione

• 11.x and 10.x
• 11.x only

• RPA Workspace
• What's new | What's changed | Summary of changes in packages alla pagina 224
• Fixes | Limitations (this release) | Limitations (previous releases)
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• Internet Explorer EOL updates
• Features

• AARI
• Novità | Cosa è cambiato | Correzioni | Limiti

• Discovery Bot
• Fix

• Document Automation
• New capability | Limitations

• IQ Bot
• Novità | Cosa è cambiato | Correzioni | Limiti

• Bot Insight
• What's changed | Fixes

• Automation Anywhere for Genesys
• Novità

• Feature deprecations
• Summary list

Top 5 developer features in this release

View the following video on the top 5 developer features:

Aggiornamento a questa versione

If you are on the previous build (Build 15097) of Automation 360 v.25, you must update to the latest Build
15112.
You can update to the latest version of Automation 360 from the previous three releases (that is, from n−3
releases, where n refers to the latest release).
The following previous releases are certified for update to Automation 360 v.25:
• v.24R2 (Build 13343), and v.24 (Build 12350, 12342)
• v.23 (Build 11513)
• v.22 (Build 10526)

Vedi anche A360 | Upgrading to A360.23, A360.24, A360.25 from A360.22 (A-People login required).

When updating from previous releases to v.25 (Build 15097), ensure that you review the information in the
following article: Error parsing the SQL instance name while upgrading to Automation 360 v.25 (A-People login
required).
If you are on one of these previous releases, for information about updating, see Aggiornamento
alla versione di Automation 360 più recente alla pagina 1063. If you are not on an n−3 release, update
Automation 360 to one of the n−3 releases before updating to Automation 360 v.25.
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Importante:  Questa versione include un aggiornamento di Bot Agent facoltativo. You can continue to
run your existing bots without updating the Bot Agent. However, if you want to use the new features in
Automation 360 v.25, you must update the Bot Agent available with this release.

For more information, see these resources:
• Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina

1043
• Compatibility with release builds alla pagina 1026

Per gli aggiornamenti più recenti delle estensioni di Automation 360 per Google Chrome, Microsoft Edge e
Mozilla Firefox, vedi Browser extensions for Automation 360 alla pagina 718.

Migrazione

Funzionalità di Enterprise 11 e Enterprise 10

Migrazione di TaskBots quando la Logic di MetaBot di riferimento viene rinominata
Ora è possibile migrare correttamente TaskBots la cui Logic di MetaBot è stata rinominata o ha
cambiato il relativo percorso dopo la mappatura.
Se una Logic di MetaBot viene rinominata o cambia percorso dopo la mappatura nel TaskBot, il
TaskBot viene migrato con il nuovo nome o percorso della Logic di MetaBot.
Il percorso del comando nel TaskBot viene aggiornato con il nuovo nome o con il percorso
aggiornato.
La modifica del percorso relativo si applica nei seguenti scenari:
• La Logic viene spostata da una cartella all'altra.
• La Logic viene spostata da una cartella principale del MetaBot a una sottocartella.
• La Logic viene spostata da una sottocartella a una cartella principale del MetaBot.
• La cartella che contiene la Logic viene rinominata.

Questo miglioramento si applica ai comandi seguenti:
• Esegui logica
• If > Logic Successful
• If > Logic Unsuccessful
• Error Handling

Rapporto di output del Bot Scanner migliorato
Nel rapporto di output del Bot Scanner, quando si fa clic sul nome di un bot che richiede un'azione
correttiva, è ora possibile visualizzare il Numero di riga dei comandi anziché il Conteggio totale
dei messaggi (frequenza).

Supporto della migrazione per l'invio di e-mail action con più allegati
È ora possibile migrare bots a cui è associato il comando Send Email con un percorso di file in una
variabile per i seguenti scenari:
• Un singolo file viene inviato come allegato.
• Più allegati vengono inviati in un'unica e-mail.
• I file vengono allegati da un'unità di rete.
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Funzionalità di Enterprise 11 e Enterprise 10

Migration support for Work Item variable (Service Cloud case ID: 01270496)
È ora possibile migrare bots con la variabile Work Item per gli scenari in cui la variabile Work Item
include i seguenti elementi:
• Un numero
• Un numero e una stringa, ad esempio una finestra di messaggio
• Una data
• Una combinazione di Datetime e stringa, ad esempio una finestra di messaggio

Nota:  Se la variabile Work Item è un tipo di Datetime, l'azione Record:Assegna viene
aggiunta automaticamente e, successivamente, convertita in una variabile di stringa del tipo
Datetime, prima dell'applicazione della variabile Work Item.

Variabili create automaticamente dopo la migrazione
Nell'utility Bot Scanner, i bots che contengono le seguenti variabili non referenziate non vengono
più contrassegnati con Azione richiesta o Revisione richiesta:
• $FileName$
• $Error Description$
• $Error Line Number$
• $Extension$
• $Folder Name$

Dopo la migrazione, il sistema crea automaticamente queste variabili in base alle convenzione di
denominazione del Automation 360 e i bots migrati vengono eseguiti correttamente.

Miglioramenti alla migrazione per packages e actions
• Se i bots migrati utilizzano l'azione Estrai testo PDF > Testo strutturato, la nuova opzione

Riduci perdita di dati garantisce la conservazione dei caratteri nel testo estratto e la corretta
esecuzione dei bot.

• Se si dispone di bots con un'espressione Xpath specifica nel pacchetto SOAP Web Service,
assicurarsi che l'output del comando SOAP per Risposta selezionata sia restituito di
conseguenza selezionando Stringa delimitata o Elenco di stringhe. Per i bot migrati,
l'opzione Stringa delimitata da Nessuno è selezionata per impostazione predefinita.

• If migrated bots use the Terminal Emulator, the Set cursor position to the beginning option
now enables you to edit the Terminal Emulator screen manually, and the focus is set to the
beginning of the editable field. Note that this option is selected by default only when the Show
terminal option is selected for these bots. (ID caso Service Cloud: 00812730, 01252363,
01804623)
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Funzionalità di Enterprise 11 e Enterprise 10

Support for 7-Zip
We have certified 7-Zip, a third-party tool, to handle backing up the Control Room repository with
lengthy file names, bot names, and folder names. You can now back up and restore the repository
of bots even when the length of the filepath to the repository of bots exceeds 256 characters.
You can run either 7z.exe commands using the command line interface or run the 7.Zip as an
application.
The 7-Zip tool support is available on the following Automation Anywhere certified Windows
operating systems:
• Microsoft Windows Server 2016
• Microsoft Windows Server2019

You can download the 7-Zip tool from 7-zip Download page.

Nuova action Aggiorna titolo della finestra per aggiornare il nome del browser nel titolo
della finestra
When you are migrating Enterprise 10 or Enterprise 11 bots that use the Internet Explorer browser,
the Update window title action now converts the window titles of these bots to Microsoft Edge
with IE mode. I titoli delle finestre vengono aggiornati in base al browser utilizzato dai bots. For
example, consider bots that use Internet Explorer and have Internet Explorer in the window
title. Dopo la migrazione, la nuova action aggiorna il titolo della finestra riflettendo le modifiche sul
nuovo browser, su Microsoft Edge e sul formato del testo come *Microsoft*Edge.
Utilizzo di azioni web legacy alla pagina 1671

Funzionalità esclusive di Enterprise 11

Automatizzazione di oggetti che appaiono dietro la finestra del tempo di esecuzione dei
bot (ID caso Service Cloud: 00710929)
Per i seguenti comandi, quando si esegue un bot, è ora possibile automatizzare gli oggetti che
appaiono dietro la finestra del tempo di esecuzione dei bot:
• Riconoscimento delle immagini > Trova la finestra nella finestra
• If/Else > Image Recognition > Window is found in window or not
• Clic del > mouse
• OCR > Acquisisci area o finestra

RPA Workspace

Novità

Supporto per Azure Application Gateway
On Microsoft Azure cluster environment for On-premises, Azure Application Gateway is now a
supported load balancer..
Versioni dei componenti del data center supportate in Microsoft Azure alla pagina 935
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Novità

Installazione di Bot Agent su dispositivi con Enterprise Client Enterprise 11
Quando si crea un bot in Automation 360, è possibile installare il Bot Agent su un dispositivo con un
Enterprise Client Enterprise 11 esistente. È possibile creare o eseguire bots da entrambe le istanze
di Control Room.
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039

Il banner di notifica di IE 11 EOL viene visualizzato in Control Room
A partire dalla versione v.25 di Automation 360, se si utilizza il browser Microsoft Internet Explorer
per accedere alla Control Room, verrà richiesto di utilizzare browser alternativi supportati come
Google Chrome o Microsoft Edge (Chromium). Quando si accede alla Control Room, viene
visualizzato un banner di notifica che indica che il supporto di Internet Explorer 11 sta per
terminare.
Accesso alla Automation Anywhere Control Room alla pagina 1022

Passaggio di Bot Agent a un'altra Control Room senza reinstallare Bot Agent
Puoi ora eseguire il passaggio di un dispositivo monoutente a un'altra Control Room senza
reinstallare Bot Agent. Accedi come amministratore e seleziona Abilitato e la casella di controllo
Consenti commutazione rapida dalle impostazioni del dispositivo.
Commutare la registrazione del dispositivo tra istanze di Control Room alla pagina 2734

Configure the VM instance to delay Bot Agent registration
You can now configure the VM instance (golden image) to delay the Bot Agent registration until the
user logs in to the Control Room from that instance. You can also configure up to 20 Control Room
URLs so that you can use the same golden image to connect to any Control Room from that list.
Bulk install Bot Agent on devices alla pagina 1053

Supporto a Automation 360 per Amazon Linux 2 su ambiente EC2 AWS
Automation 360 supporta ora il sistema operativo Amazon Linux 2 per la Control Room On-Premises
di Automation 360 per l'installazione sull'ambiente AWS Elastic Compute Cloud (EC2).
Amazon Linux 2

Out-of-sync licenses and Control Room license expiry
When licenses are oversubscribed, the Control Room enters the fail-safe state and continues to
operate in fail-safe mode for 30 days, after which the Control Room becomes locked.
When a Control Room license is within 30 days of expiration, a warning message is displayed in a
banner until the license either expires or is renewed.
Stato fail-safe della Control Room alla pagina 1004 | Notifiche di scadenza della licenza della Control
Room alla pagina 1018

Support for integration with SIEM
The Automation 360 Cloud Control Room now supports integration with security information and
event management (SIEM) to forward the audit logs.
Configurazione dell'integrazione con SIEM alla pagina 2765
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Novità

Enforce coding standards with code analysis
• Code analysis enables you to define and enforce coding standards to improve automation coding

practices. Puoi impostare diverse regole che disciplinano le modalità di codifica. With code
analysis, you can implement coding best practices and make the code more uniform, accessible,
reliable, efficient, and secure.

• Two new permissions, View policies and Manage policies, are introduced in the Control
Room for code analysis policy.

Analisi del codice alla pagina 2782

Autenticazione a due fattori per gli utenti Control Room
Se sei un amministratore Control Room, puoi abilitare l'autenticazione a due fattori (2FA) per gli
utenti che accedono alla Control Room. La 2FA fornisce un ulteriore livello di sicurezza per tutti
gli accessi alla Control Room che può essere impostata per tutti gli utenti o per gli utenti con ruoli
specifici.
Autenticazione a due fattori alla pagina 2738

Visualizzazione della cronologia delle versioni delle dipendenze dei file non-bot (ID caso
Service Cloud: 01615105)
Ora puoi visualizzare la cronologia delle versioni delle dipendenze dei file non bot. In questo modo
puoi identificare le modifiche apportate al file da altri utenti in una data e ora specifiche, insieme ai
messaggi di archiviazione.
View version history of non-bot file dependencies alla pagina 2049

Modifica dei nomi delle cartelle non vuote nell'area di lavoro privata (ID caso Service
Cloud: 00535388, 00730075, 00786633, 00791528, 01615295, 01820406)
Ora puoi modificare i nomi delle cartelle non vuote nell'area di lavoro privata. Grazie a questa
funzione, puoi gestire le cartelle in modo più semplice. Quando rinomini una cartella, accertarti di
quanto segue:
• Non deve contenere bots estratti o clonati, anche a livello di sottocartelle.
• Non deve contenere più di 100 elementi, comprese le sottocartelle e i file.

Crea e rinomina le cartelle alla pagina 2018

Visualizzazione delle mappe di dipendenza per i bots
Ora puoi visualizzare la mappa delle dipendenze per il tuo bot sia nell'area di lavoro pubblica che
in quella privata. La mappa delle dipendenze mostra i bots padre e figlio immediati per ogni bot
selezionato. Se sei uno sviluppatore RPA, puoi usare la mappa delle dipendenze per capire meglio
dove un bot viene invocato e quali bots figlio sono invocati dal bot. Grazie a queste informazioni,
puoi valutare l'impatto della variazione di un bot, utilizzare in modo efficace il bot, garantire un
codice e una capacità di riutilizzo del bot migliori e prevenire i conflitti.
View bot dependency map alla pagina 2008

Supporto per automatizzare le applicazioni supportate dall'app Citrix Workspace (ID
caso Service Cloud: 01758063)
The Citrix Workspace app is now supported on Automation 360. You can now automate applications
that are accessed through the Citrix Workspace app by using the Recorder > Capture action or
the Start recording option.
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Novità

AISense Recorder: Supporto per la lingua coreana e per le operazioni complesse sulle
tabelle
• Ora è possibile utilizzare il AISense Recorder per automatizzare le applicazioni che usano il

coreano e una combinazione di interfacce coreane e inglesi.
AISense per la registrazione di attività da applicazioni remote alla pagina 1965

• Con AISense Recorder, è possibile estrarre dati tabellari da tabelle complesse. Puoi acquisire
e automatizzare tabelle con colonne più ampie e tabelle con colonne in cui sono presente
comandi, come caselle di controllo o pulsanti di opzione. È inoltre possibile acquisire specifiche
colonne dalle tabelle.

Nota:  Se la tabella non viene rilevata automaticamente, utilizzare il comando Definisci per
rilevarla.

Table data extraction through AISense Recorder alla pagina 1979

Miglioramenti a Recorder
• Quando si esegue un bot, è ora possibile automatizzare gli oggetti che appaiono dietro la

finestra del tempo di esecuzione del bot utilizzando l'action Registratore > Acquisisci. (ID
caso Service Cloud: 00684306, 00770636, 01146672)

• Ora puoi utilizzare il Recorder per acquisire e automatizzare oggetti con una tecnologia specifica.
La scheda Acquisisci oggetto ha ora l'opzione di selezionare una tecnologia specifica e di
eseguire l'acquisizione utilizzando quella tecnologia. Puoi acquisire oggetti con le seguenti
tecnologie:
• Microsoft Active Accessibility (MSAA)
• UI automation
• Microsoft (MS) COM UI Automation

Capture using specific technology alla pagina 1770
(ID caso Service Cloud: 01760871, 01865823

• You can now use the Recorder to automate third-party plug-in window objects on Google
Chrome or Microsoft Edge browsers by using a specific technology.

Opzione Riduci perdita di dati nei PDF package
Nell'action PDF > Testo estratto, per il Testo strutturato un nuovo campo di tipo Riduci
perdita dati è ora disponibile. Utilizzando questa opzione, è possibile estrarre il testo completo con
una sovrapposizione minima di caratteri.
Using Extract text action from PDF alla pagina 1735

Miglioramenti al package String (ID caso Service Cloud: 00770822)
Nell'action Stringa > Estrai testo, è ora disponibile la nuova opzione Durante l'estrazione. È
possibile utilizzare questa opzione per specificare se la grafia del testo nella sottostringa estratta
deve corrispondere a quello della stringa di origine.
Using Extract text action of String package alla pagina 1883
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Download dei file da URL che richiedono l'autenticazione NTLM (ID caso Service Cloud:
01189873)
Con il package Browser migliorato, è ora possibile scaricare file da URL che richiedono
l'autenticazione NTLM utilizzando l'action Browser > Scarica file.

New option in Connect action of the Terminal Emulator package (Service Cloud case ID:
00812730, 01252363, 01804623)
You can now edit the screen of the Terminal Emulator session manually by selecting the Set cursor
position to the beginning check box. By selecting this option, you can now set the focus to the
first editable field. By default, this option is not selected.

Aggiornamento in blocco alla versione di package predefinita attraverso bots (ID caso
Service Cloud: 00712719, 00728499, 00737694, 00803673, 01255722, 00838604, 00772147,
01760236, 01762679, 01771416, 01761859, 01782588, 01778220, 01784255, 01789551,
01809167, 01818690)
Use Update bots to default package version to update bots to use the default version for
any package. User with the View Packages and the permission to edit the bots can now update
bots in bulk to use the default package version. This feature provides you with an efficient way to
securely update all the bots in the Control Room repository that you have access to with the default
package version in a few clicks.
Aggiornamento dei bots alla versione predefinita del package alla pagina 2651 | Example of updating
default package version across bots alla pagina 2096

Advanced search feature in the Bot editor  (Service Cloud case ID: 01615310, 01780115)
Assistente bot offre ora funzionalità di Ricerca avanzata per migliorare l'esperienza di ricerca
complessiva nel Bot editor. Ciò contribuisce a migliorare la produttività del Bot Creator. La pagina
Ricerca avanzata consente di inserire un testo di ricerca, selezionare i criteri di filtro e navigare
tra i risultati della ricerca. Puoi utilizzare i criteri di filtro per restringere i risultati della ricerca e
individuare rapidamente il testo ricercato. When you edit or view a bot, you can use the advanced
search feature to find the exact line of action and the corresponding action details where the search
text appears, that is, as a string, text value, or a variable name.

Nota:  Find in this bot is now renamed to Search in this bot.

Advanced search option in Bot editor alla pagina 1366

Miglioramenti all'opzione di invio di più allegati nell'action Invia email (ID caso Service
Cloud: 00800976, 00817136, 00821405, 00936080, 01256523, 01256320, 01262069, 01259369,
00936080, 01801928)
Quando si invia un'e-mail dai bots, è ora possibile inviare più allegati sotto forma di un elenco di file
o una variabile contenente l'elenco degli oggetti file. Grazie a questa funzione, è possibile allegare
all'e-mail file quali file di dati, fogli di calcolo e documenti di elaborazione del testo. È possibile
allegare più percorsi di file da un'unità locale o di rete, oppure utilizzare una variabile contenente un
percorso di file.
Utilizzo di Invia action alla pagina 1512

Miglioramenti al SOAP Web Service package
Quando si costruisce una risposta SOAP per un'espressione Xpath nel package SOAP Web Service, il
risultato dell'espressione Xpath può essere memorizzato sotto forma di un elenco di stringhe.
Esempio di utilizzo dell'azione Servizio Web SOAP alla pagina 2076
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Espressione tabellare comune supportata nell'action Esporta in tabella dati (ID caso
Service Cloud: 00655318)
È ora possibile semplificare join e subquery complesse utilizzando le espressioni tabellari comuni
(CTE) nei database conformi a SQL. Utilizzare le CTE nell'action Esporta in tabella dati del
package Database utilizzando la parola chiave WITH.

Miglioramenti al OCR package
Quando si utilizzano actions dal package OCR, come Acquisisci area o Acquisisci finestra, il
bot identifica ora i comandi anche se questi si trovano dietro la finestra del tempo di esecuzione del
bot. Estrae anche il testo dietro la finestra del tempo di esecuzione del bot di Automation 360 da
qualsiasi finestra di applicazione.

New package SDK version
You can now set up the default value for a global session by using default_session_value in
CommandPkg in the newly released package SDK version.

Configurazione di packages On-Premises
On-Premises administrators can now disable the latest package version from becoming the default
version automatically. Administrators can also enable a feature that fetches and installs new
package versions as and when they are released even without a Control Room upgrade.
Aggiornamenti automatici del package per On-Premises Control Room alla pagina 2726

Automazioni del carico di lavoro supportate su database PostgreSQL e Oracle
Le automazioni dei carichi di lavoro sono ora supportate anche sui database PostgreSQL e Oracle.
Tutte le automazioni dei carichi di lavoro funzionano bene con entrambi i database.
Gestione del carico di lavoro alla pagina 2797

API del trigger
Map triggers to users or roles for an attended Bot Runner user by using the Trigger API. Con l'API
del trigger puoi anche creare ed eliminare trigger di eventi.
Trigger API

Enhancement to the Authentication using apikey
With .24 or previous versions, you must replace any escape character '\' with '\\' in the API key.
With .25 or later versions, the API key will no longer have any escape characters('\').

Newly implemented Activity List API
With the newly implemented Activity List API (v3/activity/list) you can return the job
executions without call back and bot output information. The old Activity List API (v2/activity/
list) is now deprecated.
v3/activity/listBot Execution Orchestrator API

Definition:  Deprecation refers to features or capabilities available in the current (latest) release
that will be removed or unsupported from a future release.
You can use the specified alternatives or updated versions when they are made available.
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Migrate from Enterprise 11 Control Room version 11.3.4.7 to Automation 360 On-
Premises
We now support migrating from Enterprise 11 Control Room version 11.3.4.7 to Automation 360
On-Premises v.25 and later releases.
Versioni Control Room supportate per la migrazione alla pagina 1136

Cosa è cambiato

Miglioramenti al pacchetto String (ID caso Service Cloud: 00770822)
Dopo la migrazione dei bots, quando estrai una stringa di testo basata su una stringa sorgente,
l'opzione predefinita non è più impostata per corrispondere alla grafia della stringa sorgente. Per
bots nuovi, l'opzione predefinita è impostata per corrispondere alla grafia della stringa di origine.

Enhancement to the Browser package
In Enterprise 11, if a bot is using the Launch Website action to open a URL in Internet Explorer and
when migrating the bot to Automation 360, if you select the Convert bots built using Internet
Explorer to Edge with Internet Explorer mode option in the Settings panel of the Bot
Migration Wizard, the URL is automatically set to open in Microsoft Edge after migration.

Opzione per modificare la posizione della cache globale (ID caso Service Cloud: 00745395,
00781135,00831182, 01124360, 01764952)
L'amministratore può modificare la posizione predefinita della cache globale in base alle proprie
esigenze da Amministrazione > Impostazioni > Dispositivi > Opzioni avanzate.
Manage device settings alla pagina 2727

Miglioramento del server di database per istanza Control Room
Per impostare la connessione e l'autenticazione del server di database, utilizza il numero di porta
dell'istanza del server di database (numero di porta predefinito, 1433) invece del nome dell'istanza.
Configure Microsoft database type and server alla pagina 911

Per le modifiche alle credenziali dell'utente, aggiungi una nuova configurazione per le
impostazioni LDAP senza che l'autenticazione in corso dia esito negativo
Quando le credenziali di un utente vengono modificate o aggiornate, viene ora fornita una pagina
di impostazioni LDAP in modo che l'amministratore Control Room possa aggiungere la nuova
configurazione per le impostazioni LDAP senza che l'autenticazione in corso dia esito negativo.

Supporto per la corrispondenza esatta nel campo dell'oggetto per i trigger di e-mail (ID
caso Service Cloud: 00953823)
Quando colleghi la Control Room a uno dei servizi di posta elettronica presenti sul sistema e attivi
un bot quando ricevi una nuova e-mail, l'attivazione dell'e-mail viene ora eseguita in base alle
seguenti condizioni dell'oggetto:
• Quando l'oggetto viene indicato tra virgolette doppie (""), ad esempio, "Foglio di calcolo

ABC", il trigger viene eseguito solo se l'oggetto dell'e-mail ha una corrispondenza esatta con la
stringa fornita tra virgolette.

• Quando più righe di oggetto sono separate da un punto e virgola, ad esempio, foglio di
calcolo ABC; registri del progetto ABC, il trigger viene eseguito quando l'oggetto
dell'e-mail corrisponde a una qualsiasi delle righe dell'oggetto menzionate.
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Importazione di bots Enterprise 11 con o senza MetaBots (ID caso Service Cloud:
01261325)
Ora puoi importare bots Enterprise 11 (file .aapkg) con o senza MetaBots dipendenti nell'area di
lavoro pubblica. Se stai importando il file .aapkg nell'area di lavoro privata, assicurati che i MetaBots
dipendenti siano inclusi.

Summary of changes in packages

The following table summarizes the new and updated features in the Control Room packages:

Name of package or
action

New or changed
feature

Numero di versione Versione agente bot

AISense Recorder Support for Korean
language and complex
table operations
Lingua coreana e
supporto di tabelle
complesse

2.7.3-20220527-004608 21.210 or later

Browser package Support to download
files from URLs
that require NTLM
authentication
Autenticazione NTLM

3.5.1-20220527-172031 21.210 or later

Database package Support for common
table expression in
Export to data table
action
Supporto CTE in Esporta
in tabella dati

4.8.0-20220504-130202 21.88 or later

Email package Support for sending
mail with multiple
attachments through
bots
Send email with multiple
attachments

3.12.3-20220516-11485421.210 or later

OCR package Support to identify and
capture controls behind
bot runtime window
Support to capture
controls that appear
behind the runtime
window

2.10.0-20220502-20431821.118 or later
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New or changed
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Numero di versione Versione agente bot

PDF package Support to extract
complete text with
minimal overlap of
characters
Estrai testo in modo
accurato

3.5.2-20220414-101844 21.31 or later

Recorder • Support to automate
objects that appear
behind bot runtime
window
Automatizza gli
oggetti dietro la
finestra di runtime del
bot

• Support to automate
objects with specific
technology
Automatizza gli
oggetti con una
tecnologia specifica

• Support to automate
applications
accessed through
Citrix Workspace
app
Automatizza le
applicazioni su app
Citrix Workspace

2.7.3-20220527-004608 21.210 or later

SOAP Web Service
package

Support to store output
of Xpath expression as
list of strings
Memorizza l'output
dell'espressione Xpath
come elenco di stringhe

3.11.3-20220426-06442321.90 or later

String package Support to match case
of text in extracted
substring to that in
source string
Match case of substring to
that of source string

5.4.2-20220412-134724 20.18 or later

Importante:  For information about the packages supported with this release, see also View package
versions available in the Control Room alla pagina 2009.
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15112 01838276, 01835897 When you update to Automation 360 v.25, an error no
longer occurs when the database server includes the
instance name.

Builds 14304 and
15112

01834139,
01839933,
01841993,
01839817,
01834108,
01846407,
01845706,
01843349,
01846220,
01846819,
01845547,
01847028,
01847024,
01847094,
01847114,
01847115,
01846998,
01847840,
01846757,
01848123,
01846944,
01848104,
01848294,
01848905,
01846596, 01849748

When you successfully export a bot, the latest bot
export activity is now displayed on the Historical
activity page. Previously, the latest export event was
not displayed as the Ended on column was displaying
the value as N/A.

Builds 14304 and
15112

01836296 When you delete a user or a role, only one entry
is now generated for each action in the audit log.
Previously, multiple duplicate audit log entries were
generated for a single action, affecting the user
management workflows.
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Build 14304 and
15112

01842547,
01846156,
01847338,
01846324,
1842368, 01847054,
01848080,
01848789,
01848151,
01848963,
01847054,
01847121,
01848236,
01848260,
01849016,
01848248,
01848572,
01847828,
01847055,01848826,
01848191,
01848944,01851181,
01849792, 01852057

When you use the Wait > Wait for condition action
with conditions that have specific timeout values set,
the bot now waits only for the specified waiting time
then runs the subsequent action. Previously, even
when you specified a timeout value, the bot waited
indefinitely.

15097 01274643, 01812436 Se disponi di una funzione in una DLL che utilizza una
variabile credenziale come parametro di input e se la
variabile credenziale non è disponibile in Automation
360, verrà visualizzato il messaggio di migrazione
A108. In precedenza, veniva visualizzato il messaggio
di migrazione E153.
Messaggi di migrazione alla pagina 1302

15097 -- Ora puoi migrare bots anche se la data e il mese sono
in formato numerico a una o due cifre e l'anno è in
formato numerico a una, due o quattro cifre per le
date Modificato prima e Modificato tra nell'action
File and Folder. In precedenza, era necessario
specificare le date nel formato MM/GG/AA prima di
migrare i bots.

15097 01260742 Dopo la migrazione, quando il sistema trasferisce
una variabile tipo Valore credenziale (CV) da un
bot padre a una variabile non CV con logica MetaBot,
la variabile temporanea di tipo stringa creata per
contenere il CV ora non supera i 50 caratteri e non
include uno spazio non valido.

15097 00796546 L'utilità di pre-migrazione Bot Insight può ora risolvere
gli ID dei dashboard corrotti presenti nelle tabelle BI
e generare il file dashboards.zip per la migrazione. In
precedenza, quando nelle tabelle BI venivano rilevati
ID dashboard corrotti, l'utilità di pre-migrazione Bot
Insight riscontrava un errore e si chiudeva.
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15097 01758427, 01805913 Nell'applicazione SAP, quando si utilizza il comando
azione Clic, le schede vengono ora selezionate con
precisione.

Nota:  Il valore Tipo in Enterprise 11 viene
rinominato come Ruolo in Automation 360.

Quando si migra da Enterprise 11 a Automation 360,
il valore Ruolo viene automaticamente impostato sul
valore corrispondente al valore Tipo di controllo SAP
in Sottotipo se il valore Tipo in Enterprise 11 è stato
impostato su GuiShell. Ad esempio, in Enterprise
11, se il valore Tipo è stato impostato su GuiShell
e il valore Sottotipo è stato impostato su Vista a
griglia, in Automation 360, il valore Ruolo viene
impostato automaticamente su Vista a griglia.

15097 01376353,
01449535,
01713118,
01627144, 01762404

Quando si aggiorna la Control Room da Automation
360 v.21 o v.22 a Automation 360 v.25, l'installazione
viene ora completata correttamente senza che si
verifichi alcun errore. In precedenza, l'installazione
non riusciva quando gli utenti che avevano creato i
programmi di migrazione perdevano le autorizzazioni
dopo la migrazione.

15097 01257547,
01722892,
01291187,
01770716, 01777450

Ora è possibile modificare o eliminare una
pianificazione, poiché non è più possibile eliminare
un file .atmx associato a una pianificazione dalla
Control Room Automation 360. In precedenza, dopo
l'eliminazione del file .atmx, veniva generato un
errore che impediva di modificare o eliminare una
pianificazione.

15097 01255723,
01252824,
01260677, 01608653

Quando si esegue la migrazione dei bots Enterprise 11
con il comando Comment abilitato, il comando resta
ora disabilitato dopo la migrazione.

Nota:  Se il comando Comment contiene una variabile
o un simbolo $, il comando viene disabilitato dopo la
migrazione.

15097 01755175 È ora possibile migrare bots con variabili di sistema
(quali data, mese o anno) con l'opzione Esporta dati
in CSV senza che si verifichi alcun errore.
In precedenza, in simili circostanze veniva visualizzato
un errore di pre-elaborazione.

15097 01261863 È ora possibile migrare bots con variabili di sistema o
espressioni che includono variabili di array senza che si
verifichi un errore. In precedenza, in simili circostanze
si verificava un errore di preelaborazione.
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15097 01758814 You can now migrate bots when the MetaBots Logic
call each other and another, third Logic calls one of
these in recursion. In precedenza, in simili circostanze,
la migrazione del bot non riusciva e veniva riportato il
messaggio "Si è verificato un errore imprevisto".

15097 01255810 Quando si esegue l'azione Invia testo due volte per
lo stesso valore in Terminal Emulator e il primo campo
è protetto, se la schermata di Terminal Emulator viene
caricata per la seconda volta, essa verrà visualizzata
correttamente dopo la migrazione.
In precedenza, quando la schermata Terminal
Emulator veniva ricaricata per la seconda volta, si
verificava un comportamento errato.

15097 01770547 Nei comandi Automation 360, le espressioni in cui una
variabile è racchiusa tra parentesi ed è preceduta da
un simbolo $ vengono ora migrate correttamente,
con la variabile all'interno delle parentesi preceduta e
seguita dal simbolo $.

15097 01258964 Dopo la migrazione, l'action Acquisisci permette ora
di identificare le finestre a comparsa che utilizzano lo
stesso titolo di una finestra principale della SAP GUI.
In precedenza, l'action Acquisisci non permetteva di
identificare le finestre a comparsa che utilizzavano lo
stesso titolo di una finestra principale.

15097 00745395,
00781135,
00831182,
01124360, 01764952

Se il percorso della cache globale supera i
256 caratteri, Automation 360 modificherà
automaticamente il percorso nella posizione predefinita
sebbene il percorso nell'interfaccia utente mostri
il percorso configurato dall'utente. In precedenza,
quando il percorso della cache globale superava i
256 caratteri, Automation 360 visualizzava un errore
durante il download dei packages.

15097 01767018,
01755092,
01765551,
01764245,
01778477,
01782790, 01795043

Se l'utente non dispone delle autorizzazioni di
accesso per un trigger o una cartella con trigger nella
scheda pubblica, ora non viene visualizzato alcun
messaggio di errore nella pagina dei trigger di eventi.
In precedenza, se un utente non disponeva delle
autorizzazioni di accesso, la pagina di attivazione
dell'evento per l'utente visualizzava un errore nella
scheda pubblica.

15097 01765445,01759831,
01779960, 01799422

When you log in to the Control Room as an
administrator, you can no longer delete users that
have active schedules.
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15097 01255678 Nella pagina Gestisci > Dispositivi, la colonna
Modificato da ora visualizza correttamente il
nome utente dell'ultimo utente che ha modificato i
dettagli. Ad esempio, se user1 registra un dispositivo
e successivamente user2 modifica i dettagli del
dispositivo, ad esempio Tipo di distribuzione, viene
visualizzato il nome utente di user2 in luogo del nome
utente di user1 nella colonna Modificato da.

15097 -- Quando si installa la Control Room (On-Premises),
anche se è configurato un archivio chiave esterno,
è ora possibile inserire manualmente le credenziali
del database e configurarle per l'autenticazione del
database nella pagina del programma di installazione
di Windows Server di database.

15097 01753671 Quando si effettua l'aggiornamento a questa versione,
nella sezione Visualizza cronologia TaskBot, le
colonne Archiviato e Archiviato da visualizzano ora
le informazioni corrette.

15097 -- Now when you run bots that have the Get Total
Rows command in the SAP GUI, the values are
returned as Integer data type. In precedenza, tali
comandi restituivano i valori come tipo stringa Float.

15097 01212822 Durante l'automazione del carico di lavoro, è
ora possibile visualizzare e utilizzare code anche
se il nome di un modello di elemento di lavoro
contiene spazi iniziali o finali. Sebbene gli spazi siano
visualizzati nel nome della coda, essi vengono rimossi
automaticamente quando viene creato il modello di
elemento di lavoro. Inoltre, gli spazi iniziali o finali nei
nomi delle code vengono ignorati durante l'esecuzione.
In precedenza, i nomi delle code e dei modelli con
spazi iniziali o finali non venivano visualizzati e,
pertanto, non erano disponibili per la selezione.

15097 01772061 Quando si effettua l'aggiornamento a questa
versione, Automation 360 non consente l'esecuzione
contemporanea di più processi di sincronizzazione delle
licenze. In precedenza, quando erano in esecuzione
più processi di sincronizzazione delle licenze, i log di
audit mostravano errori Licenze sincronizzate.

15097 01754415 When you update from Automation 360 v.21 or
later, the Bot Agent devices are no longer shown
as disconnected in the Control Room Manage >
Devices page. When you try to update Bot Agent in
versions prior to Automation 360 v.21, a message now
indicates that the device is not compatible.
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15097 01780460 Quando si effettua l'aggiornamento a questa versione,
le opzioni Avanzate della Control Room per i
dispositivi (Amministrazione > Impostazioni >
Dispositivi), come Timeout accesso automatico,
Numero massimo di download simultanei e
Tempo di attesa risposta bot non tornano più ai
valori predefiniti.
Ad esempio, se si imposta Timeout accesso
automatico su 70, dopo l'aggiornamento a questa
versione, il valore rimane a 70 e non torna al valore
predefinito.
In precedenza, quando si aggiornava la Control Room,
ad esempio, dalla versione di Automation 360 v.22 alla
versione di Automation 360 v.23, le opzioni Avanzate
per i dispositivi tornavano ai valori predefiniti.

15097 01762582,
01808698, 01815446

La pagina della Control Room Attività visualizza ora
correttamente il numero totale di attività pianificate. In
precedenza, quando erano presenti più di 200 attività
pianificate, la pagina della Control Room Attività
mostrava solo 200 attività ed era necessario ordinarle
in base alle colonne Nome attività, Priorità di
automazione o Modificato da per visualizzare il
numero corretto di attività pianificate.

15097 01764492 Durante l'installazione di Automation 360 Control
Room, il file di registro generato dal programma di
installazione non mostra più la password in chiaro.

15097 -- Nella pagina Amministrazione > Impostazioni
> E-mail, se l'opzione Richiedi verifica non è
selezionata, non ricevi più un link di verifica nella
notifica e-mail per verificare l'utente. Ora puoi
accedere alla Control Room senza verificare l'ID e-mail
e impostare le credenziali di accesso. In precedenza,
veniva inviata una notifica via e-mail con un link di
verifica per verificare l'indirizzo e-mail anche se non
selezionavi l'opzione Richiedi verifica.

15097 01783110 Quando avvii un bot, se il bot fallisce durante
l'esecuzione, la pagina Attività > Cronologia in
Control Room mostra ora il valore corretto Ora di
inizio cioè l'ora in cui il bot è entrato in esecuzione.
In precedenza, quando l'esecuzione di un bot
non riusciva, il messaggio Ora di inizio mostrava
erroneamente l'ora in cui l'esecuzione del bot non era
andata a buon fine. Di conseguenza, le colonne Ora di
inizio e Ora di fine mostravano la stessa ora, il che
non era corretto e creava confusione.
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15097 01826944, 01828683 When you log in to the Control Room, the Activity
> Historical page now loads without error. For the
historical data in the JOBEXECUTION table, a new
Cloud data retention policy of 90 days is implemented,
whereby the Cloud historical data is deleted along
with the rollout of Automation 360 v.25 to the
different regions. Previously, when you logged in to
the Control Room, the Activity > Historical page
did not load because of a large number of records,
and the following error message was displayed: An
unexpected problem has occurred

• Visualizza attività completate alla pagina 2614
• Automation 360 Cloud FAQ alla pagina 54

15097 01753337, 01785865 Nella pagina Attività > In corso, quando utilizzi la
funzione di ordinamento per elencare gli elementi
nella colonna Ora di inizio in ordine crescente
o decrescente, gli elementi sono ora elencati
correttamente.

15097 -- Ora puoi stabilire con successo una connessione
SQL sicura in ambiente Linux scegliendo l'opzione
Abilita nel campo Configurazione del database
> Configurazione sicura > Connessione sicura.
Il programma di installazione di Linux importa ora
con successo il certificato SSL e la connessione viene
stabilita. In precedenza, il programma di installazione
di Linux non riusciva a importare il certificato SSL e la
connessione non veniva stabilita.

15097 00781974 In ambiente Linux, non si verificheranno più
problemi di arresto dei servizi a causa di problemi
di archiviazione del disco. In precedenza, alcuni
dei messaggi di registro Control Room venivano
memorizzati nel file /var/log/messages invece che
nella directory /var/log/automationanywhere, con
conseguente riduzione dello spazio su disco.

15097 01260701 Quando si eseguono bots sui dispositivi utente, i bots
non rimangono più bloccati nelle code. Inoltre, non
vengono più visualizzati i seguenti messaggi:
• In attesa dell'utente username
• Scelto in fase di esecuzione
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15097 01760032 I nomi di dominio non sono più sensibili alla distinzione
tra maiuscole e minuscole ed è ora possibile creare
utenti utilizzando la mappatura dei gruppi Active
Directory e mappare un ruolo a un utente nella Control
Room. In precedenza, poiché alcuni server Active
Directory restituivano nomi di dominio in maiuscolo,
mentre altri erano in minuscolo, i nomi di dominio non
potevano essere trovati e si verificava un problema con
la funzione di mappatura dei gruppi.

15097 00828289 The Global Value fields are now validated and have a
maximum length of 4000 characters.

15097 00828289 When you navigate to My settings >
My Profile > Edit in the Control Room
and provide a link, for example, <a
 href="www.google.com">LinkInjection</
a>, the email sent contains a link, and the email text
sent is validated against HTML injection and you will
no longer see a functional link.

15097 01754431,
01773662,
01789555,
01791065,
01784255,
01785653, 01780070

Quando si utilizza il Recorder per acquisire un oggetto,
impostare il tempo di attesa per il rilevamento
dell'oggetto sotto i 30 secondi nel campo Continua a
provare per (secondi) ed eseguire il bot. Il Recorder
attende ora il tempo specificato per rilevare l'oggetto
e il caricamento completo della pagina. In precedenza,
il Recorder attendeva un minimo di 30 secondi per
rilevare l'oggetto, indipendentemente dal tempo
specificato.

Nota:  Questa correzione si applica solo ai browser
Google Chrome e Microsoft Edge Chromium.

15097 01614810 È ora possibile utilizzare uno spazio vuoto come
delimitatore nel campo Specifica delimitatore
(facoltativo). Nell'action Apri del package CSV/
TXT, quando si sfoglia il percorso file per aprire un
file, aggiungere uno spazio vuoto come delimitatore
nel campo Specifica delimitatore (facoltativo)
ed eseguire il bot. Lo spazio vuoto viene ora trattato
correttamente come delimitatore e il bot viene
eseguito correttamente.

15097 01387738 Quando si utilizza l'action Browser > Apri per aprire
una nuova finestra in Google Chrome, la finestra
viene ora attivata e visualizzata davanti a tutte le altre
finestre aperte. In precedenza, quando si eseguiva un
bot, la finestra rimaneva nello stato ridotto a icona.
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15097 01273095 Quando inserisci un valore decimale con 16 o più
decimali in una cella di un foglio di calcolo di Microsoft
Excel e utilizzi l'opzione Leggi valore cella nelle
actions Excel avanzato > Ottieni cella singola,
Ottieni più celle o Ottieni foglio di lavoro come
tabella dati per recuperare il valore decimale dalla
cella, il formato del valore della cella non cambia più
da Generale a Scientifico.

15097 01144509, 01767881 Durante la connessione a una sessione SAP, utilizzare
la condizione del Recorder Se > L'oggetto esiste
per identificare e acquisire gli oggetti dell'applicazione
SAP, scollegare la sessione SAP ed eseguire queste
actions in un ciclo. Il bot rileva ora correttamente gli
oggetti in ogni iterazione del ciclo. In precedenza,
quando il bot veniva eseguito in un ciclo, venivano
acquisiti correttamente gli oggetti solo durante la
prima iterazione, ma non durante quelle successive.

15097 01769573 Se si utilizza l'action Integrazione app > Acquisisci
il testo della finestra per acquisire il testo di una
finestra del prompt dei comandi, quando si esegue
il bot, il bot acquisisce correttamente tutti i caratteri
di ogni riga. In precedenza, il bot non riusciva ad
acquisire gli ultimi caratteri di ogni riga.

15097 01628448,
01766957,
01788709,
01788801,
01789538,
01803156,
01781597,
01810230,
01811694,
01802054,
01815687,
01823526,01814962,
01833962,
01835418,
01835382,
01837832,01830790

Il package Excel advanced funziona ora come previsto
e senza alcun problema. In precedenza, il package
generava a intermittenza un errore di eccezione
generico.

15097 00824995,
01451063, 01274854

Nell'action PDF > Estrai campo, quando si seleziona
l'opzione Apri visualizzatore PDF, selezionare un
file PDF dalla Control Room o dal desktop, fare clic su
Carica e aprire il visualizzatore PDF. È ora possibile
visualizzare il documento PDF. In precedenza, quando
si selezionava l'opzione Apri visualizzatore PDF
per visualizzare il documento PDF selezionato, veniva
visualizzata una pagina vuota ed era possibile vedere
il valore del documento PDF solo selezionando un'area
rettangolare specifica nel campo vuoto.
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15097 00957308 Nell'action File > Copia file desktop, quando
specifichi un percorso file di origine in cui il nome
della cartella contiene un carattere numerico (#) o
il nome del file contiene un carattere jolly, specifica
un percorso file di destinazione per copiare il file
ed eseguire il bot. Il bot rileva ora il percorso file di
origine e copia il file nella posizione di destinazione
specificata. In precedenza, quando si eseguiva il bot,
il bot non riusciva a rilevare il percorso file di origine
e, di conseguenza, a copiare il file nella cartella di
destinazione.

15097 01685239 A questo punto, puoi utilizzare il Recorder per
acquisire gli oggetti nell'applicazione Citrix Xenapp,
utilizzare la condizione Se > L'oggetto non esiste
per verificare l'esistenza di un oggetto specifico
nell'applicazione ed eseguire con successo un bot
da un bot padre. In precedenza, quando tentavi di
eseguire questa operazione, si verificava un errore.

15097 01260387 A password-protected Microsoft Excel file is no longer
corrupted when you open the file manually after
successfully running a bot using the Excel basic
package. Previously, when you used the actions in the
Excel basic package to open a password-protected
Excel file, made some updates to the file, and closed
the file by selecting Save changes when closing
file in the Excel basic > Close action, the password-
protected Excel file became corrupted when you
opened it manually from its location.

15097 00920617 Quando ti connetti alla tua casella di posta elettronica
tramite il protocollo IMAP, utilizza Per ogni e-mail
nella casella di posta come iteratore del loop di
posta elettronica per recuperare tutti i messaggi
ricevuti prima del filtro della data ed eseguire il bot. Il
bot recupera ora tutti i messaggi e-mail ricevuti prima
della data specificata, compresi quelli ricevuti nella
data specificata prima dell'ora specificata.

15097 -- Nei browser Google Chrome, Microsoft Edge e Mozilla
Firefox, ora puoi aprire con successo gli URL di rete
che iniziano con due caratteri barra rovesciata (\)
utilizzando l'action Browser > Apri.

15097 01015001 Quando specifichi il numero totale di packages che
desideri visualizzare per pagina nella sezione Gestisci
> Pacchetto nella Control Room, la pagina visualizza
ora il numero corretto di packages specificato. In
precedenza, tutti i packages venivano visualizzati in
un'unica pagina anche se sceglievi di visualizzare solo
un numero specifico di packages.
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15097 01711629 Nell'action Registratore > Acquisisci, selezionando
una finestra del browser specifica il cui titolo
corrisponde a un'altra finestra browser della
scheda Browser ed eseguendo il bot, il bot apre
correttamente la finestra del browser selezionata. In
precedenza, quando il titolo di due finestre del browser
coincideva, il bot apriva casualmente una finestra del
browser con il titolo corrispondente.

15097 -- Ora puoi utilizzare l'action Browser > Esegui
JavaScript per eseguire con successo JavaScript sulle
pagine Web che contengono iFrames.

15097 01075660, 01273111 Le actions Excel avanzato > Apri e Crea cartella
di lavoro visualizzano ora il valore della sessione
Predefinito nel campo Sessione locale.

15097 01252773,
01278029,
01772301, 01765017

An error no longer occurs when you use the Excel
advanced > Open action to open a worksheet that is
a type of hidden chart or a macro. You can specify the
sheet name to open the worksheet of type macro.

Nota:  When you open the default sheet, ensure that
the active sheet is an Excel Worksheet. If the active
sheet is of type chart, the following error message
is now displayed: The Excel file does not
contain an active sheet to open. Please
make sure the Excel file you want to
open has at least one active sheet.

15097 -- After migration, when you run the bots that use File
and Folder packages, the year under the Date option
now accepts the value 00 as input, which is considered
as year 2000.

15097 01257829 Nelle actions di package Servizi Web REST, è ora
possibile aggiungere un tipo di contenuto Custom, con
cui è possibile aggiungere contenuti che non rientrano
nei tipi di contenuti standard.

15097 -- Nelle actions di package Servizi Web REST, è ora
possibile eseguire Aggiungi sostituto, tramite cui
è possibile inserire variabili nel corpo della richiesta
REST.

15097 01784553, 01794924 Nelle actions di package Servizio Web SOAP, il
carattere ampersand (&) viene ora automaticamente
evaso. In precedenza, il carattere ampersand (&),
ossia un carattere di controllo riservato, non veniva
evaso automaticamente, generando file XML non
validi.
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15097 01767571 Nelle actions di package Servizi Web REST, le
nuove righe nel corpo della richiesta non vengono
più modificate in fase di esecuzione. Ad esempio,
quando il corpo della richiesta contiene una nuova
riga, questa non viene più sostituita da uno spazio in
fase di esecuzione. In precedenza, quando il corpo
della richiesta conteneva una nuova riga, questa
veniva sostituita da uno spazio.

15097 00773353, 00787270 In the REST Web Services package actions, you can
now use the user token option to access the Control
Room APIs. When you log in to the Control Room, a
token is generated, which is used by the bot to access
the endpoints of the Control Room API used within the
bot.

15097 01372460 È ora possibile eseguire bots utilizzando l'action
EseguiScript del package Legacy Automation.
Quando si passano più argomenti per sostituire i valori
di un documento di Microsoft Word, il bot ora esegue
la funzione, sostituendo e visualizzando il testo su una
nuova riga. In precedenza, il testo veniva visualizzato
sulla stessa riga.

15097 01758458 When you use the Connect action to establish a
connection with an email server, use the Disconnect
action to close the connection with the same session
name. You will then not encounter any issue when you
establish a new connection again with the same or
different credentials.

15097 01273357 È possibile creare un bot per eseguire un flusso di
lavoro standard in SAP BAPI. L'output viene ora
generato correttamente come file .CSV. In precedenza,
quando si eseguiva un flusso di lavoro standard in SAP
BAPI, l'output generato variava.

15097 01342887 Quando si esegue un processo usando il package
Terminal Emulator, la finestra del terminale viene
ora attivata e rimane in primo piano. In precedenza,
quando si eseguiva un processo, la finestra del
terminale non veniva attivata e rimaneva ridotta a
icona.

15097 01251933 Nel package Terminal Emulator, quando si utilizza
l'azione Connetti per stabilire una connessione con
TN3270E, non si verifica più alcun errore. Previously,
an error occurred, and the following error message
was displayed on the mainframe screen: Errore
ISR@PRIM del pannello ISPP904 - x'0E'
o x'0F' non è valido come carattere di
attributo
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15097 01432885 Quando si esegue un bot, la metrica TaskBot
eseguiti nella pagina del dashboard Home della
Control Room non mostra il conteggio corretto. In
precedenza, la metrica visualizzava un conteggio
errato. Ad esempio, nella sezione del dashboard
Home, se il conteggio TaskBot eseguiti mostrava
39, quando si eseguiva il bot, il conteggio visualizzato
era pari a 42 anziché a 40.

15097 00742840 Quando si utilizzano actions come Apri ed Esegui
funzione dal package DLL, non si riscontrano
più problemi. Il bot apre ora il file DLL anche se la
lunghezza del percorso file DLL è inferiore a 256
caratteri.

15097 01261786, 01615115 Quando si modifica un bot e si disabilita qualsiasi
action al suo interno, è ora possibile utilizzare la
scorciatoia da tastiera Ctrl+Z per annullare un'action.
In precedenza, la scorciatoia da tastiera Ctrl+Z non
funzionava come previsto.

15097 01080067 Nel package Active Directory, quando si utilizzano
nomi utente con caratteri speciali, il bot viene
ora eseguito correttamente. In precedenza, se si
aggiungeva un utente a un gruppo e il nome utente
conteneva caratteri speciali, quando si cercava di
rimuovere l'utente dal gruppo, il bot non poteva essere
eseguito.

15097 00962414 Non si riscontra più alcun problema durante la
connessione a un'applicazione puTTY tramite Terminal
Emulator. In precedenza, quando il terminale veniva
collegato all'host, quest'ultimo richiedeva una
password. Successivamente, lo schermo del terminale
si oscurava e il bot visualizzava il seguente errore:
Impossibile collegarsi al terminale.
Verificare i dettagli della connessione

15097 00829259 In Active Directory, è possibile creare un utente
tramite una delle seguenti opzioni: Richiedi modifica
della password al prossimo accesso oppure
Non richiedere la modifica della password
al prossimo accesso. In precedenza, quando
si utilizzava l'action Connetti per stabilire una
connessione, se il percorso di connessione LDAP
conteneva l'attributo OU con un valore spaziale come
OU=aa unit, si verificava un errore quando si
eseguiva il bot.

15097 00961069 When you are using the Send text action from
the Terminal Emulator package, you can now send
numeric keyboard minus (-) keys with Alt+- (Alt
+hyphen) keys to the mainframe application.
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15097 00825675 Quando si elimina la mappatura delle variabili da bots
padre e figlio, quindi si esegue il bot padre, il bot non
riscontra più alcun errore. In precedenza, quando si
eliminava la mappatura delle variabili da bots padre e
figlio, quindi si eseguiva l'analisi del bot padre, il bot
non poteva essere eseguito.

15097 00798604 Quando si utilizza l'action Esegui funzione dal
package VBScript, il bot non riscontra più alcun errore.
È ora possibile specificare il nome della funzione da
eseguire e passare argomenti contenenti parentesi
([]). In precedenza, l'action Esegui funzione non
veniva eseguita se una parentesi aperta o chiusa era
inclusa in qualsiasi posizione in un parametro stringa.

15097 -- Quando utilizzi un file DLL disponibile nella Control
Room e il percorso del file DLL è inferiore a 260
caratteri, il bot recupera correttamente il file DLL.

15097 01149730 Ora puoi collegarti a un server e-mail, selezionare il
protocollo IMAP, utilizzare l'iteratore Loop > Per
ogni e-mail nella casella di posta e scaricare
con successo gli allegati da un messaggio e-mail e
salvarli in una cartella specificata. In precedenza, se gli
allegati avevano un file bin, non venivano scaricati o
salvati in una cartella.

15097 00919896 Utilizzando actions come Invia testo o Invia chiave
dal package Terminal Emulator, il programma di avvio
dei bot non smette più di funzionare. In precedenza,
i bots creati utilizzando actions dal package Terminal
Emulator a volte smettevano di funzionare a caso
quando veniva abilitato un set di caratteri a doppio
byte (DBCS) e la schermata host aveva un campo a
capo.

15097 00950682 Ora puoi utilizzare l'action Apri foglio di calcolo nel
package Google Sheets senza alcun problema, anche
se utilizzi un file Proxy Auto-Configuration (PAC) o un
ambiente abilitato al proxy.

15097 01257464 Quando ti connetti a un server e-mail con la
configurazione IMAP e utilizzi l'action Sposta tutto
con un filtro per tutta la posta ricevuta prima di una
certa data, tutti i messaggi e-mail che soddisfano il
criterio possono essere spostati da una cartella all'altra
senza alcun problema.

15097 01753270 Nel package Google Drive ora puoi utilizzare l'action
Crea autorizzazione file con l'opzione ID file. In
precedenza, quando utilizzavi Crea autorizzazione
file, se nessun'altra action Google Drive risultava
anteposta, si verificava un errore.
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15097 01276141 Nel package e-mail, quando utilizzi l'action Sposta
tutto o l'iteratore Loop > Per ogni e-mail nella
casella di posta, puoi aggiungere un numero
qualsiasi di indirizzi e-mail nel campo Da mittente
specifico. In precedenza, il loop di posta elettronica
non funzionava se il campo Da mittente specifico
conteneva più di due indirizzi e-mail.

15097 01689348 You can no longer import bots with incomplete
package files from one Control Room to another
because the system now disallows and rejects the
import of incomplete package files.

15097 01763262, 01762153 You can now create a bot and run stored
procedures successfully. Previously, if you had
two stored procedures in different databases,
for example, Database A.dbo.SP_A and
Database_B.dbo.SP_B, in the SQL Server, if
you were connected to Database_A and wanted
to run the stored procedure in Database_B, the
execution failed because the fully qualified stored
procedure name was not supported in the Run stored
procedure action.

15097 -- You can now successfully download exported bots by
navigating to Activity > Historical > Bot Export:
Export.<date_name > Download exported zip
file.

15097 01762348 I Bots che vengono distribuiti dalla Control Room sui
dispositivi utenti non vengono più bloccati in una coda
dopo che i Bot Runners non assistiti vengono aggiunti
da un pool di dispositivi.

15097 01151181 Se si dispone delle autorizzazioni necessarie, è ora
possibile eliminare correttamente una pianificazione
inattiva dalla pagina Gestisci > Pianificazione >
Attività pianificata. In precedenza, anche se si
disponeva delle autorizzazioni necessarie, quando
si tentava di eliminare una pianificazione inattiva
veniva visualizzato un messaggio di errore relativo alle
autorizzazioni.

15097 00917927, 01255618 Il campo Modificato da nella pagina Gestione >
Pianificazione visualizza ora il nome utente corretto
per le pianificazioni ricorrenti. In precedenza, quando
le pianificazioni venivano importate da un ambiente
all'altro, il campo Modificato da mostrava il nome
utente del Bot Creator o dell'amministratore originale.

© 2023 Automation Anywhere. All rights reserved.     240



    Automation Anywhere - Learn

Correzioni

Crea ID caso Service
Cloud

Descrizione

15097 01778350, 01803570 Quando si crea una pianificazione nella Control Room,
la pagina Gestisci > Pianificazione > Visualizza
attività > Pianifica visualizza adesso l'ora di fine
corretta per il campo Data di fine. In precedenza,
quando si selezionava una data di fine per una
pianificazione, l'ora di fine mostrata per il campo Data
di fine non era corretto.

15097 -- In ambiente Kubernetes, quando si tenta di creare una
coda, non si verifica più alcun errore.

15097 00716776,
00778659,
01820190, 01856732

If you check out an item at certain time T1 and then
cancel the checkout later at time T2, the canceled
checkout is not considered as a modification to
the item. Also, the last modified time is rolled back
to time T1 that is when the bot was checked-out
last time from the Public folder. Previously, the
canceled checkout at certain time T2 was incorrectly
considered as a modification to the item. Also, the
last modification time was incorrectly shown as time
T2 that is when checkout was canceled. Thus, it was
difficult to keep track of actual modification dates of
items.

15097 -- In ambiente Kubernetes, è ora possibile eliminare gli
elementi di lavoro anche dopo aver messo in pausa
una coda. In precedenza, quando si metteva in pausa
una coda e si tentava di eliminare un elemento di
lavoro, talvolta un errore impediva l'eliminazione
dell'elemento di lavoro.

15097 01255617 I filtri WLM nella pagina Coda > Elementi di lavoro
restituiscono ora risultati accurati. In precedenza, i
filtri non funzionavano con precisione quando venivano
combinati.

15097 01806221,
01805371,
01818356, 01828330

After you update to Automation 360 v.24, WLM
tasks no longer fail. Previously, after an update, bot
execution processes or actual bot execution sometimes
failed, resulting in the failure of WLM tasks as well.

15097 01769740 Le descrizioni del Bot vengono ora visualizzate
anche dopo l'archiviazione o l'estrazione del bot. In
precedenza, dopo aver effettuato l'archiviazione o
l'estrazione di un bot per la prima volta, le descrizioni
del bot non venivano più visualizzate.
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15097 01764336 Ora viene visualizzato un messaggio di errore
appropriato quando cerchi di cambiare lo stato
dell'elemento di lavoro da Pronto per l'esecuzione
a In attesa o Completato. Il messaggio di errore
informa che, poiché la coda è già in uso, devi mettere
in pausa o interrompere l'automazione della coda
per modificare lo stato dell'elemento di lavoro. In
precedenza, il messaggio di errore visualizzato non
aiutava a risolvere il problema.

15097 01273374 L'API gettasklogdata mostra ora i dati in tempo
reale, per cui i valori dell'ora locale vengono convertiti
in valori UTC per la richiesta API in questione.

La seguente tabella elenca le limitazioni identificate nella versione attuale:

Limitazioni

Bots whose queue category name contains a space (for example, Input – Emails) cannot be
migrated because during migration, such bots enter and remain in an infinite loop until the loop
times out at 90 minutes. (ID caso Service Cloud: 01850864)
Soluzione: You can migrate to Automation 360 v.26 release where this issue is fixed or remove the
space in the queue category name and then migrate the bots.

After you migrate your bots, an error occurs in the following situations:
• When you use FTP actions on bots with commas in filenames
• When you use the Delete files and Delete folder FTP actions on bots with colons in filenames

Soluzione:
• For bots that use FTP actions, ensure that you remove commas from the filenames.
• For bots that use the Delete files and Delete folder FTP actions, ensure that you remove

colons from the filenames.

When you try to migrate bots in which the If condition is used for more than 95 times in a single
line, migration fails with the following error message: Unexpected response status: 500
(Service Cloud case ID: 01830793)
Soluzione: Divide the bot into multiple logical sub-bots.

(ID caso Service Cloud: 01773164) If the number of cells in a table object exceeds 300,000, the
Control Room might become unresponsive.
Soluzione: Ensure that the number of cells in a table object does not exceed 300,000.

Anche se il percorso della Control Room non è valido o non esiste, il percorso non valido
viene comunque visualizzato in luogo del percorso predefinito: C:\ProgramData
\AutomationAnywhere\GlobalCache\

© 2023 Automation Anywhere. All rights reserved.     242



    Automation Anywhere - Learn

Limitazioni

When you run a migrated bot with the Recorder package, the Click Action on Client Control
might not work. This issue occurs because some Microsoft Windows operating systems might not
be activated properly on a few Windows applications.
Soluzione: Use the Left Click action.

When you try to re-edit a migrated bot with the Record > Dataset variable, an error occurs,
and the following error message is displayed: An unexpected problem occurred. If the
problem persists, please contact your system administrator.

Soluzione: Refresh the Bot editor page to reload the details.

A parse error occurs when you run a migrated bot with the Email Received Date variable used
twice in subactions inside the Email loop action.

Quando si crea un bot utilizzando l'action Invia e-mail, se l'allegato include il simbolo di minoranza
(<) come carattere speciale nel percorso file, il carattere speciale verrà rimosso dopo l'esecuzione
del bot. Il sistema operativo Windows non supporta tale carattere speciale.

In un bot, quando crei una variabile Elenco con sottotipo File, selezioni il valore come file Control
Room e aggiungi il package List, l'esecuzione del bot fallisce quando si esegue il bot.

If your bot has an error, you add the Try/Finally block around the corresponding actions, and
insert more actions in the Finally block, when you save and run the bot, the Bot error dialog
shows the wrong error line number within the Finally block.
Soluzione: If you are using Try and Finally without using the Catch action, the Bot error dialog
does not show the correct line number. Instead, use Try/Catch. The Try action handles the error
and sends execution to Catch with line number and description. This gives the correct line number
within the Finally block.

When you frequently connect to the Excel or Access (Microsoft Office 2016 or later) engines with
ODBC drivers, bot execution fails intermittently.

When you use the Connect action to connect with the EWS protocol, read email skips the newline
characters and prints the email message body on a single line. This issue is also observed in the
Send email action. Following are the scenarios where these issues are observed:
• Create a bot and connect with the EWS server. Use the Loop action to read emails as a plain

text message and use the Log to file action to log text into a file.
• Use the Send email action and connect with the EWS server with OAuth authentication to

send the email.

In un pool di dispositivi, quando selezioni l'opzione Esegui bot ora per un bot WLM, l'esecuzione
del bot WLM viene attivata e viene visualizzato un messaggio di errore.
Soluzione: Per eseguire un bot WLM in un pool di dispositivi, assicurati di selezionare l'opzione
Esegui bot con coda.

In un ambiente multitenant, quando carichi un file elemento di lavoro in coda in uno dei tenant, la
scheda In corso visualizza lo stesso file elemento di lavoro anche per tutti gli altri tenant.
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Limitazioni

In un pool di dispositivi, quando interrompi un'automazione WLM, alcuni elementi di lavoro
rimangono nello stato di pronto per l'esecuzione. Di conseguenza, questi elementi di lavoro non
possono essere eliminati.
Soluzione: Per eliminare gli elementi di lavoro che si trovano nello stato di pronto per l'esecuzione,
esegui una delle seguenti azioni:
• Metti in pausa e interrompi l'automazione.
• Esegui nuovamente, metti in pausa e quindi interrompi l'automazione.

After migration, when you use the Excel advanced > Open action to open a file with the Load
Add-ins option enabled and the system has COM add-ins enabled, when you run the bot, the bot
might fail with an error.
Soluzione: Disable the Load Add-ins option to run the bots successfully.

When you use the If > Folder does not exist condition to determine that a folder does not exist,
even if the folder exists, the bot might fail to identify it due to the leading and trailing spaces in the
input folder path. As a result, the bot might throw an error.

When you update the Control Room to the latest version, you might see some packages with two
default versions.
Recommendation: Sometimes, you might notice the duplicate packages a few weeks after the
Control Room is updated. Hence, we recommend that you compress and save the Control Room
logs dir that contains all the WebCR*.log files 30 minutes after the Control Room is updated. This
way, if you discover the issue later, these logs from the time of update will be available and help in
investigating this issue.

In the Data Table > Assign action, when you select the Table with values option, select the
Edit table (1 X 1) option to edit a table, enter variables in the rows and columns and then run the
bot, the output still shows the input $variable$ instead of the evaluated value of the variable.

When you try to upload packages to the Control Room manually, the system does not check for the
minimum required version of the Control Room that is compatible with the packages before they
are uploaded. It allows the packages to be uploaded in the Control Room even if the version of the
packages is not compatible with the currently installed version of the Control Room.

When you use the Run bot option to run a bot in the Activity > Historical > View page for any
activity, the bot execution fails with an error.

(ID caso Service Cloud: 01784401) To ensure that multiple Git processes are not modifying the
same repository at the same time in the Control Room, Git lock is implemented for a short interval.
After the lock is released, repository-related operations are resumed without any issues. However,
in some instances, the Git lock is not released, and new Git operations cannot be processed. As
a result, repository-related operations, such as edit, save, import, and check-in, are delayed and
eventually time out.
Soluzione: contatta l'assistenza Automation Anywhere.

When you use the If package, add a specific condition with a variable, then add specific conditions
within a group, save the bot, and if you rename the variable that was used, the name of the
variable might not update for the Group conditions but is only updated for the conditions in the
Condition tab.
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Limitazioni rispetto alle versioni precedenti

Quando si esegue la migrazione a un bot utilizzando l'action Manage Window Controls, l'ultima
cifra del valore dell'altezza non è disponibile dopo la migrazione. Tuttavia, il bot verrà eseguito
correttamente. (ID caso Service Cloud: 01756996)

Quando una sessione di Excel è attiva in SAP, si avvia un processo Excel corrispondente in
background. In questo scenario, Automation 360 utilizza lo stesso processo Excel iniziato da SAP.
Quando si esegue un bot per automatizzare i dati del foglio di calcolo, Automation 360 elabora la
prima richiesta con successo. Tuttavia, durante l'esecuzione, se l'Excel viene chiuso e viene inviata
una successiva richiesta di automatizzazione dei dati del foglio di calcolo, Automation 360 non
elabora la richiesta perché il processo Excel è ancora in fase di accesso da parte di SAP. Pertanto,
non viene attivata la finestra corretta per automatizzare i dati del foglio di calcolo. (ID caso Service
Cloud: 00815159)

• If you are updating from Automation 360 On-Premises v.21, remove the following Bot Agent files
and folders:
• C:\Windows\System32\config\systemprofile\AppData\Local

\AutomationAnywhere\AA-DB.mv.db
• C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-resources

• Before you update from Automation 360 On-Premises v.22, refer to the upgrade considerations
in Aggiornamento alla versione di Automation 360 più recente alla pagina 1063.

(ID caso Service Cloud: 00837271) Se si sta migrando da Enterprise 11 con un database che ha
una grande quantità di dati d'archivio, l'installazione potrebbe non riuscire. Questo problema si
verifica perché l'aggiornamento di Liquibase per alcune query SQL non viene completato durante la
migrazione.
Soluzione: Contact Automation Anywhere Support.

When you try to automate any process in a Java application that uses version 11.0.8 of
AdoptOpenJDK, the Recorder might not capture the drop-down elements on the application.

Quando utilizzi il Recorder per acquisire un oggetto, selezioni le proprietà Tag HTML, Testo
interno HTML e Tipo HTML in Criteri di ricerca o esegui la migrazione a un bot con proprietà
simili selezionate in Criteri di ricerca, il bot non riesce a identificare o localizzare l'oggetto e ad
eseguire l'azione selezionata.
Soluzione: Modify the DomXpath according to the controls you capture, or add more properties
in Search Criteria.

When you use the Browser > Close action to close a tab or a window opened in the Microsoft
Edge browser, if only one Microsoft Edge browser window is open, the bot encounters the following
error: Error occurred while closing the tab
Soluzione: Vedi Configure Microsoft Edge browser settings when Close action of Browser package
encounters an error (A-people login required)

Aggiornamenti Internet Explorer EOL

Nota:  This release (Automation 360 v.25) includes features from Automation 360 v.24R2 (Build 13331).
Per informazioni sui contenuti disponibili nella versione v.24R2, consultare Note sulla versione di v.24R2
Automation 360 per EOL Internet Explorer 11 alla pagina 259.
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Funzionalità

Packages e actions
You can now migrate Internet Explorer bots from Enterprise 11 and Enterprise 10 to Automation
360 and convert the bots to Microsoft Edge with IE mode for the following actions and
commands in the Web Recorder package:
• actions Passa all'URL, Vai indietro e Didascalia Cerca per.
• Comandi Apri browser e Chiudi browser. Questi comandi sono mappati nelle actions

Automazione legacy > Apri pagina e Chiudi pagina in Microsoft Edge con modalità IE.

Per l'avvio di bots Internet Explorer, nel package Automazione legacy, selezionare l'opzione
Avvia Internet Explorer in modalità di compatibilità Edge.
To migrate and convert Internet Explorer bots, in the Control Room, from Administration >
Migration > Migrate bots, select the Convert bots built using Internet Explorer to Edge
with Internet Explorer mode option.

Automation Anywhere Robotic Interface (AARI)

Nota:  For Automation 360 v.25, AARI does not support an Oracle Database. You can continue to use
AARI with Microsoft SQL Server.

Novità

Use Bot Task labels to identify bot version to run
In Attività del bot, è ora possibile selezionare la versione di un bot per la distribuzione, scegliendo
tra le opzioni Ultima versione ed Etichetta di produzione. Quando si distribuisce il bot, viene
eseguita la versione del bot selezionata.
Crea un processo AARI alla pagina 2133

Bot priority reference
In Attività del bot, ora puoi fare riferimento al livello di priorità dei bots. Per bots impostati su un
livello di priorità, la sezione Priorità bot mostra ora un'etichetta di sola lettura Bassa, Media o
Alta.
Crea un processo AARI alla pagina 2133

Creazione di una richiesta in una nuova scheda
È ora possibile aprire ed eseguire le nuove richieste in una scheda separata selezionando l'opzione
Apri richiesta in una nuova scheda nel modulo iniziale. Con questa opzione, è possibile creare
simultaneamente richieste senza modificare la navigazione nella pagina corrente.
Crea una richiesta e completa un'attività alla pagina 2163
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Novità

Pianificatore non valido
Un pianificatore non è valido quando un utente del pianificatore viene rimosso dal suo ruolo o
quando non può accedere a un file a causa di autorizzazioni mancanti. Gli utenti che ricevono
la notifica di pianificatore non valido sono l'amministratore Control Room, l'amministratore AARI
e l'utente AARI. Ora, l'amministratore della Control Room vedrà una modifica del log di audit,
l'amministratore AARI vedrà un messaggio di errore per riassegnare un nuovo utente pianificatore e
l'utente AARI vedrà un messaggio di errore durante il processo.
Assegnazione dell'utente del pianificatore al processo nell'interfaccia web alla pagina 2118

Righe duplicate per l'elemento Tabella
Nell'interfaccia Web, quando si aggiungono righe al modulo utilizzando l'elemento Tabella, è ora
possibile risparmiare tempo duplicando una riga della tabella con la nuova opzione Duplica riga.
La riga duplicata verrà ora posizionata sotto la riga evidenziata selezionata.

Supporto a ulteriori tecnologie per i trigger interfaccia
È ora possibile utilizzare i trigger interfaccia con le seguenti tecnologie:
• Windows nativo
• Desktop SAP
• Browser Google Chrome ed Edge Chromium

Add an interface trigger alla pagina 2213
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Novità

Miglioramenti alle regole dei moduli
• Utilizzo della formattazione personalizzata

Quando si aggiunge una regola, se si utilizza il menu Se per impostare le condizioni della
regola su determinati elementi, ad esempio Casella di testo o Area testo, è ora possibile
selezionare È dal menu a discesa per attivare altre opzioni. Select the Custom option and click
Add regular expression to apply custom formatting requirements on the selected element.
Si consideri uno scenario in cui gli ID utente di tutti i dipendenti hanno come prefisso AV. Ad
esempio, per un dipendente il cui nome è Adam, l'ID utente è AVAdam. Utilizzare l'opzione
Aggiungi espressione regolare per impostare il valore nel campo Espressione regolare
come ^AV. Se un utente inserisce Adam nel campo ID utente, appare un avviso.

• Impostazione di un valore personalizzato o aggiunta di un valore di elemento
Quando si aggiunge una regola, utilizzare il menu Quindi per selezionare un elemento modulo.
Per questo elemento modulo, è possibile impostare una delle azioni corrispondenti usando
Imposta valore o Aggiungi valore:
• Valore: I dati inseriti nel campo Inserisci valore vengono applicati all'elemento

selezionato.
• Elemento modulo: I dati dell'Elemento modulo selezionato nel menu a discesa Seleziona

elemento vengono aggiunti.

Si consideri uno scenario in cui un modulo di registrazione utente contiene i campi "Nome" e
"ID dipendente". È possibile impostare una delle seguenti regole per il valore del campo ID
dipendente:
• Selezionare Valore e inserire Emp1013 come valore preimpostato.

Questo valore viene visualizzato nel campo "ID dipendente" durante l'esecuzione del bot.
• Selezionare Elemento modulo e impostare l'elemento "Nome" nel menu a discesa

Seleziona elemento.
Il valore del campo "Nome" viene aggiunto al campo "ID dipendente" quando il bot viene
eseguito.

Puoi usare gli elementi nello stesso modo in cui utilizzi le variabili in Bot editor. Puoi inserire $
per visualizzare un elenco di elementi.

Aggiunta di regole agli elementi di un modulo alla pagina 2202

Cosa è cambiato

Richiesta di riferimenti per il package Web AARI
The AARI web package now supports reference IDs. Un ID di riferimento è una combinazione di
un prefisso e di un numero che viene creato da una chiave di processo e incrementato ogni volta
che viene creata una richiesta. ID richiesta viene sostituito da Riferimento richiesta e ID team
viene sostituito da Riferimento team.
AARI Web package alla pagina 1369
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Cosa è cambiato

Process and package version changes in Get Storage file action
L'action Ottieni file di archiviazione richiede ora la corrispondenza delle versioni tra la versione
del processo e la versione del package. I processi creati prima di Automation 360 v.25 devono
essere utilizzati con versioni del package precedenti alla Automation 360 v.25. Allo stesso modo,
i processi creati dopo la versione Automation 360 v.25 devono essere utilizzati con package di
versioni successive alla Automation 360 v.25.
AARI Web package alla pagina 1369

Correzioni

Crea ID caso Service
Cloud

Descrizione

15112 01841448, 1839118,
1844817, 01846153,
01846332, 01839254

When you download a series of packages from the bot
compilation, the download is now faster.

15112 01847675 After you update to Automation 360 v.25, when you
modify a process in a private workspace, you can now
save your changes successfully, without encountering
an error. Previously you will get a process error when
you attempt to modify and save your process, or when
you open the same process again.

15112 01848192 After you update to Automation 360 v.25, you can now
insert or modify conditions, such as the If/Else logic,
to your process without any issues. Previously when
you made changes or add the If/Else element to the
process logic, a Go to element would be added to the
logic which caused a process error.

15097 01807181,
01809192, 01816444

Utenti cloud: You can now successfully upload a file
for your requests. This applies to some scenarios when
you upload a file and the request creation fails.

15097 01771877 In the process editor, at the end of your process, you
can now drag Go To and add it to your End Point.

15097 01774331 When you use the Row before scrolling option from
the Table element and specify a number of rows, the
web interface now renders the correct number of rows
that you specified.

15097 -- When you use the Document element and click the
Fit option to fit your document in request view, the
document is now scaled to fit the frame entirely.

15097 -- If you design a form with a drop-drown rule applied to
it, when you view the drop-down in read-only mode
in the web interface, you can now view the changed
data.

15097 -- After you are disconnected, when you log back in to
the web interface, the next= parameter is no longer
shown in the URL and you are now redirected to the
page that you were on before you were disconnected.
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Correzioni

Crea ID caso Service
Cloud

Descrizione

15097 -- For the Text Box element, the Does not contain
form rule now works correctly.

15097 -- For the Rich Text Editor element, the Contains
form rule is now working correctly.

15097 -- Quando si crea un modulo con gli elementi
Documento ed Elenco a discesa, è ora possibile
inviare il modulo senza problemi.

15097 -- You can now use Request Reference as a parameter
in the AARI web package.

15097 01803846 You can now use Request Reference in the AARI
web package, for example, as an output for the
Create a Request action. Request ID is now
replaced by Request Reference.

15097 -- You can now successfully submit an initial form that
has a table with no content, data, or rows.

15097 01803019 When you open and view a task, the task assignment
now correctly shows the user assigned to that task.

Limitazioni

When you attempt to delete a request that is associated with more than one file, the deletion fails.

After you create a request from a private process, when you attempt to open and run the request
in a new tab, a new tab is generated but it fails to run the request and the URL is not correct.

Discovery Bot

Fix

ID caso Service Cloud Descrizione

00971940, 01018262,
01255326, 01829662

You can now successfully record a process without encountering an
error because when you log in to the Control Room, the proxy settings
now support the following scenarios:
• No proxy is enabled.
• Proxy is entered with username and password.
• Proxy is entered without username and password.

Previously, when you recorded a process, if there was no proxy and if
you entered a username and password with proxy enabled, an error
occurred.
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Document Automation

New capability: Document Automation è la nuova soluzione nativa del Cloud per l'elaborazione
intelligente dei documenti che gli utenti aziendali possono impostare per leggere ed elaborare
automaticamente e rapidamente i documenti utilizzando modelli preaddestrati e feedback di convalida.
Document Automation è completamente integrato in Automation 360: Document Automation è installato
come parte del sistema Control Room, mentre gli RPA bots vengono utilizzati per estrarre dati semi-
strutturati per automatizzare i processi aziendali incentrati sui documenti e Automation Anywhere Robotic
Interface gestisce il processo di estrazione end-to-end e le attività di convalida.
Document Automation alla pagina 2553

Limitazioni

Although the v.26 Document Extraction package appears in the .v25 On-Premises Control Room,
features will not work as expected.
Workaround if the package version is auto-synced: Manually change the Document
Extraction package version to v.25. Consulta Aggiornamento dei bots alla versione predefinita del
package alla pagina 2651.

Document Automation non supporta la distribuzione SDS.

Google Document AI pretrained models are available only for Cloud customers who purchased
licenses through Automation Anywhere.

Customers who install Document Automation on Linux must separately download the Document
Extraction package.

Document Automation supporta un nome utente dispositivo di 21 caratteri o meno.

The value beside the Validate documents link, which indicates the number of documents
awaiting validation for a learning instance, sometimes does not appear.

Learning instances that use Google Document AI models do not reliably extract tables that span
multiple pages.

When you are validating a document in public mode, if you zoom in or out, you cannot drag the
corners of the system-identified region (SIR) selection.

When you are validating a document, if you draw a box, zoom in, and then click Fit to screen, the
box appears at a different location from where you clicked.

Se ti connetti a un'istanza di apprendimento da Automation 360 IQ Bot con un campo facoltativo
che ha un valore predefinito e alcuni campi non mappati, quando elabori i documenti in
quell'istanza di apprendimento in Document Automation, il valore predefinito appare nei campi non
mappati.

Non c'è alcuna notifica se la licenza del prodotto sta per scadere. Quando la licenza del prodotto
scade, la scheda Istanze di apprendimento viene rimossa dalla Control Room.

You might encounter extraction issues when you process documents with tables that span multiple
pages.
Soluzione: Contatta il tuo Customer Success Manager per scaricare una patch per il package
Document Extraction.

When a bot runs an action from the Document Extraction package, the Activity > In progress
page shows the item name as IQBotAutoExtract.

The Bot Agent does not verify whether the Document Extraction package version is compatible with
the Control Room version prior to running a bot.
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Limitazioni

Document Automation cannot process documents in Automation Anywhere pretrained models if the
Bot Agent runs through a proxy.
Soluzione:
• With authentication: Create a Windows environment variable HTTP_PROXY with a value of

http://<username>:<password>@<proxyhost>:<proxyport>.
• Without authentication: Create a Windows environment variable HTTP_PROXY with a value

of http://<proxyhost>:<proxyport>.

If a document is renamed to a new file extension and uploaded to a Google Document AI
pretrained model, the document will fail processing.
Soluzione: Rename the document to the correct file extension.

Bots containing actions from the Document Extraction package must be deployed as part of an
AARI process. Standalone bots are not supported.

In alcuni casi, Bot Agent non cancella la cartella delle risorse. Finché lo spazio su disco non sarà
liberato, i documenti di produzione in elaborazione ne risentiranno. Questo problema si verifica a
intermittenza.
Soluzione: In base al problema, devi creare un'attività di pianificazione per ripulire la cartella delle
risorse ogni giorno o settimanalmente.

IQ Bot

Nota:  For Automation 360 v.25, IQ Bot does not support an Oracle Database. You can continue to use IQ
Bot with Microsoft SQL Server.

Novità

Migrazione dei ruoli associati a un'istanza di apprendimento
È ora possibile recuperare un elenco di ruoli personalizzati con accesso a un'istanza di
apprendimento in un ambiente di origine e concedere agli utenti di un ambiente di destinazione
l'accesso all'istanza di apprendimento utilizzando l'API Migrazione dei ruoli.
IQ Bot roles migration APIs (A-People login required)

Monitoraggio del numero di pagine elaborate nei moduli standard separatamente da IQ
Bot
La pagina Licenze della Control Room mostra ora il numero di pagine elaborate nei moduli standard,
nel Classificatore e tramite IQ Bot. Se le licenze sono state aggiunte alla Control Room dal Cloud, la
pagina Licenze mostra anche il numero di pagine elaborate in altre istanze della Control Room.
Licenze Automation 360 alla pagina 1010
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Cosa è cambiato

Reinstall IQ Bot services using a new script
È ora possibile reinstallare tutti i servizi IQ Bot insieme in un batch o scegliere di reinstallarli
singolarmente utilizzando lo script reinstall-allservices.bat.
Lista di controllo post-installazione alla pagina 1088

Correzioni

ID caso Service Cloud Descrizione

00780662 L'errore di arrotondamento non causa più la mancata convalida della
formula per i documenti. In precedenza, questi documenti venivano
convalidati manualmente.

01763658 For the Concatenate Images action in the IQ Bot Pre-processor
package, if a filename does not exceed 256 characters, the output is
now successfully generated.

01795651 Quando esporti il file IQBA da un'istanza di apprendimento di un tipo
di dominio personalizzato con gruppi manuali a un'altra istanza di
apprendimento, l'Etichetta del gruppo manuale viene ora esportata
correttamente. In precedenza, senza una Etichetta del gruppo
manuale, era difficile distinguere tra gruppi generati dal sistema e
gruppi manuali nelle nuove istanze di apprendimento.

00780712 Quando importi i file IQBA utilizzando i dati di VisionBot, tra le
istanze di apprendimento, ora puoi vedere i nuovi gruppi creati. In
precedenza, quando venivano caricati i documenti, non venivano creati
nuovi gruppi.

-- Non viene più visualizzato alcun messaggio di errore quando si
modifica la lingua di visualizzazione di un'istanza di apprendimento
che contiene un documento in Validator. In precedenza, anche se la
lingua di visualizzazione selezionata veniva applicata correttamente a
un'istanza di apprendimento, il sistema mostrava un errore.

-- Quando si utilizza l'opzione Sovrascrivi per importare un'istanza
di apprendimento, il Gruppo di convalide predefinito viene ora
sovrascritto correttamente. In precedenza, il Gruppo di convalide
predefinito non veniva sovrascritto ed era necessario modificare
manualmente l'istanza di apprendimento dopo aver importato il file
IQBA e, successivamente, cambiare il gruppo predefinito.

-- Quando utilizzi il package IQ Bot Extraction, ora puoi visualizzare
il conteggio dei documenti nella pagina Dettagli dell'istanza
di apprendimento. In precedenza, se elaboravi documenti non
appartenenti ad alcun gruppo creato, questi non venivano visualizzati
nella pagina Dettagli dell'istanza di apprendimento.

-- Ora è possibile ordinare la colonna CaricamentoPagine nella
scheda Istanza di apprendimento > Gruppo di documenti.
In precedenza, veniva visualizzato il seguente messaggio di errore:
System error, please try again after some time
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Correzioni

ID caso Service Cloud Descrizione

-- In Designer, quando si ridimensiona la regione identificata dal sistema
(SIR) di un campo a mappatura automatica, i valori della selezione
ridimensionata vengono ora acquisiti con precisione nel campo del
valore corrispondente.

-- Database Migration Assistant Tool now notifies with an error if there
are any environmental issues (such as missing DLL). Previously, the
tools and logs indicated that migration was complete, even if a unified
database was not created.

-- Quando carichi un nome di file non inglese utilizzando il dominio
Fattura e lo elabori con il comando AutoExtract, ora vengono generate
le regioni identificate dal sistema. Previously, to process the documents
successfully, you had to convert the non-English filename to English
characters.

-- Se importi un'istanza di apprendimento con un gruppo di convalida
predefinito in un ambiente in cui l'istanza di apprendimento era stata
precedentemente eliminata, l'impostazione del gruppo di convalida
predefinito rimane intatta. In precedenza, l'istanza di apprendimento
importata appariva senza il gruppo di convalida predefinito.

-- Il nome dell'intestazione della colonna per il Gruppo di convalide
predefinite appare ora nel file Projectdetails.csv ottenuto
dall'esportazione di un'istanza di apprendimento.

-- Per un'istanza di apprendimento dei moduli standard, se si tenta di
elaborare un numero elevato (più di 10.000) documenti utilizzando
l'action Elabora documenti dal menu package IQ Bot Extraction,
alcuni documenti potrebbero non essere elaborati.

-- Durante gli aggiornamenti del package IQ Bot Extraction, anche
quando utilizzi Tesseract4 OCR, non si verificano ritardi nei tempi di
elaborazione dei documenti e nella produzione dei risultati.

-- Nelle istanze di apprendimento dei moduli standard, è ora possibile
impostare un valore predefinito per i campi opzionali. Se l'estrazione
non riesce per un campo facoltativo, il sistema utilizza il valore
predefinito impostato.

-- È ora possibile accedere alle istanze di apprendimento dei moduli
standard create in versioni precedenti di IQ Bot installate con la chiave
di archivio CyberArk.

Limitazioni

IQ Bot Cloud: If you do not access IQ Bot within the configured Ideal time out value set on the
IQ Bot server, the following things happen:
• Viene visualizzato un messaggio per il riavvio di IQ Bot.
• I Bots che utilizzano le API di IQ Bot non funzionano al riavvio del server.

Aggiornare la pagina Web di IQ Bot dopo un certo periodo di tempo (più di 5 minuti) per accedere a
IQ Bot.
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Limitazioni

Sulla schermata del Validator, se vengono utilizzati valori errati per aggiornare un campo su cui
sono state applicate le convalide, non viene visualizzato un avviso quando si perde il focus del
campo.

Se utilizzi l'action Elabora documenti dal package IQ Bot Extraction per estrarre il contenuto da
un numero elevato di documenti (oltre 1 milione), viene visualizzato un messaggio di errore e IQ
Bot potrebbe smettere di rispondere.

Quando accedi all'applicazione IQ Bot su Internet Explorer11, le seguenti funzionalità non operano
come previsto:
• Export option on the dashboard
• Icone nell'elenco dei menu
• Elenco di azioni nella pagina Bot
• Icona Azione per l'istanza di apprendimento
• Funzionalità del validator, come le seguenti:

• Aggiungi righe
• Elimina righe
• Funzionalità di ricerca
• Nascondi icona
• Tipo di dati per i campi modulo

Nella Community Edition IQ Bot, quando si utilizza un OCR Cloud per creare un'istanza di
apprendimento, se si utilizza l'action Elabora documento di IQ Bot dal package IQ Bot Extraction,
i valori delle fatture o dei documenti caricati non vengono elaborati correttamente.
Soluzione: Se si utilizza il OCR Cloud per creare un'istanza di apprendimento, utilizzare l'action
Carica documento di IQ Bot dal package IQ Bot.

When you click the Create Backup option on the Migration Management page and select the
learning instances to be backed up by using the Search drop-down list, the learning instances
selected become deselected. Di conseguenza, non è possibile effettuare un backup delle istanze di
apprendimento.
Soluzione: Invece di utilizzare l'elenco a discesa Ricerca, seleziona le istanze di apprendimento
dall'elenco della pagina Esegui il backup dell'istanza di apprendimento.

In un'istanza di apprendimento di Native Validator, quando tenti di inserire o modificare i dati di
una tabella figlia che non esiste nella tabella padre, non viene rilevato alcun errore, il che porta a
salvare i documenti con valori errati.

Quando utilizzi il pacchetto IQ Bot Extraction insieme ad altri comandi basati su OCR (come ad
esempio IQ Bot Pre-processor, IQ Bot Classifier, AISense Recorder e OCR) in un singolo bot, il bot
ha esito negativo.
Soluzione: assicurati di aver creato bots separati per IQ Bot Extraction e non eseguire IQ Bot
Extraction insieme ad altri packages che includono l'OCR Abbyy 12.2.

Quando installi IQ Bot con autenticazione Windows e CyberArk Vault, non è possibile ruotare la
chiave e viene visualizzato il seguente messaggio di errore: Si è verificato un errore
durante l'impostazione della nuova chiave. Controlla i registri
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Limitazioni

In alcuni casi, Bot Agent non cancella la cartella delle risorse. Finché lo spazio su disco non sarà
liberato, i documenti di produzione in elaborazione ne risentiranno. Questo problema si verifica a
intermittenza.
Soluzione: In base al problema, devi creare un'attività di pianificazione per ripulire la cartella delle
risorse ogni giorno o settimanalmente.

If you have a document with more than 100 pages, an error message is displayed intermittently
when you click See extraction results for an existing learning instance.

Se utilizzi la versione 12.4 di ABBYY FineReader Engine invece della versione 12.2, la funzione MICR
non supporterà l'estrazione dei dati dai documenti in lingua giapponese.

When you download an unclassified document, click Delete from the server, and then toggle
the learning instance from production to staging, and vice versa, as a consequence, the same
document starts reappearing in the untrained output folder, and when you download the document
from untrained groups, the same document reappears even though it has been deleted.

When you upload documents to production using IQ Bot Upload > Run the command,
toggle the learning instance from production to staging, and then toggle back to production, all
unprocessed documents appear blurred.
Soluzione: Upload documents to Staging using an API.  Upload document to Staging API (A-People
login required)

As a result of upgrading Control Room and IQ Bot from A360.21 to A360.25, you are unable to edit
groups in the learning instances, and move groups from Staging to Production.
Workaround:
1. Restore the latest IQ Bot database backup.
2. Run the delete query.
3. Delete from EncryptionKey.
4. Run the following query: NSERT INTO EncryptionKey ([Key],

[Type]) VALUES ('xDxQoAhIc/R0nF+bFXHuo6/UGnnm6Hqs/
uBVxYpz1IdU6UAEUUVYf5vnFJU6qkBcnCAvdQOUjdwrJWwWW4LdKA==','data')

5. Start the A360.25 installer.Post upgrade checklist:
6. Ensure that following logs details are not available in installion-helper.log file: [ INFO]: main/

com.automationanywhere.cognitive.installationhelper.infrastructure.datarotation.DataRotationServiceImpl
- Rotation starts.

7. Run the API, and ensure that the filename has proper value (it should not be "fileName" :
"THIS STRING IS NOT ENCRYPTED",). http://localhost:9996/organizations/1/projects/
%7BLearningInstanceID%7D/categories/%7BgroupNumber%7D/files

Nota:  Replace the value of {LearningInstanceID} and {groupNumber} properly. Also,
GroupNumber should belong to same learning instance.

Non c'è alcuna notifica se la licenza del prodotto sta per scadere. Quando la licenza del prodotto
scade, la scheda Istanze di apprendimento viene rimossa dalla Control Room.
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Bot Insight

Cosa è cambiato

I dashboard ora richiedono l'uso del package Analyze versione 2.3.0-20210922-121532 o
successiva. This version of the package is available from Automation 360 v.23.
Dashboard di Bot Insight alla pagina 2956

Correzioni

ID caso Service Cloud Descrizione

01755186 Quando si usa un filtro su un singolo widget, il filtro viene ora applicato
correttamente solo al filtro in questione, come previsto. In precedenza,
un filtro destinato a un widget specifico veniva talvolta applicato anche
ad altri widget.

Automation Anywhere for Genesys

Novità

Automate tasks for Genesys platform with Genesys package for Automation 360
Use the actions in this package for onboarding and updating records in the repository. Ogni
tavolozza action offre la possibilità di creare record singoli e in blocco e di cancellare/rimuovere
actions per i record. You can list or search records for referencing the IDs required for updating
other records. You can also organize the records for communication purposes and contextual
insight. The action palettes in this package include the following:
• Creazione del record: Utente, divisione, telefono, contatti esterni
• Organizzazione dei record: Gruppo, coda, organizzazione esterna
• Attributi del record: Lingua, ruolo, abilità

Genesys package alla pagina 1582

Feature deprecations

Review features and capabilities (from Automation Anywhere or other third-party vendors) that are
deprecated or nearing deprecation to understand how they impact your automation. For more information,
see also this page: Feature deprecations affecting Automation Anywhere products alla pagina 759.
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Human-Bot Collaboration 11.3.x deprecated
The Human-Bot Collaboration (HBC) 11.3.x was deprecated from August 2020 with the release
of Enterprise A2019.15, after which the product has not been actively developed or maintained.
Customers that are using HBC 11.3.x are required to migrate to the Automation 360 platform to
use Automation Anywhere Robotic Interface (AARI), Web or Desktop. For this migration, there is
no automated migration path because of an absence of parity between the two products (including
sets of features). Any path that you take to migrate from HBC 11.3.x to the Automation 360
platform will involve significant manual steps to convert and map bots and other assets (such as
forms, teams, and tasks) to AARI assets (such as bots, forms, processes, teams).
Feature deprecations affecting Automation Anywhere products alla pagina 759

Basic authentication in Exchange online
Microsoft has announced that starting October 1, 2022 Basic authentication will be permanently
disabled in Exchange Online. This change will impact bots used for email automation that connect
to Exchange Online with Basic authentication using IMAP, POP3, or EWS protocols. Hence, Microsoft
recommends customers to switch from Basic authentication to OAuth 2.0.
To maintain business continuity of the impacted bots, Automation 360 customers and partners can
leverage the OAuth 2.0 feature support in Email package and Email trigger that will be delivered in
the week of Aug 29th, 2022.
Deprecation of Basic authentication in Exchange Online alla pagina 792 | Everything about Basic
Authentication deprecation in Microsoft Exchange online (A-People login required)

Manifest V2 extensions for Google Chrome and Microsoft Edge
As Google will deprecate Manifest V2 extensions by June 2023, this might impact your existing
automations that use our current MV2 extensions in Google Chrome and Microsoft Edge browsers.
You can choose to use the enterprise group policy to continue to use Manifest V2 extensions until
June 2023(Manifest V3 transition timeline). However, post this date, you have to switch to Manifest
V3 extensions for your automations to work.
We plan to provide Manifest V3 extensions for Google Chrome and Microsoft Edge with our next
release Automation 360 v.26. We recommend that you now start planning to switch to Manifest V3
extensions.
Chrome and Edge Manifest V3 extensions alla pagina 807

Tesseract v3 OCR planned change from October 2022
Tesseract is an open source OCR engine leveraged by Automation 360 IQ Bot as part of document
processing and extraction. Tesseract v3 has not been updated since 2018, and it will no longer be
packaged with Automation 360 IQ Bot from the next release v.26 (planned for October 2022).
Tesseract 3 OCR was removed as an option from the IQ Bot learning instance creation user
interface about 2 years back (in our v.13 release). However, we continued to package this older
OCR version, which ensured that learning instances previously created on Tesseract 3 can function.
Starting from our next release Automation 360 v.26, Automation 360 IQ Bot will no longer package
Tesseract 3. From v.26 release, document processing against learning instances with Tesseract
3 will result in an error, indicating that this OCR version is not available. However, the learning
instances will remain in the system, allowing customers to view their details and train with
alternative OCR options (including Tesseract v4 OCR).
For all existing learning instances trained using Tesseract v3 OCR, we recommend that you plan
to train them with alternative OCRs (including Tesseract v4), before you update to v.26. Note that
Automation 360 IQ Bot Cloud customers will receive v.26 release by default from October.
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IQ Bot Extraction package deprecation from October 2022
As part of Automation 360 v.25, IQ Bot Extraction package will no longer support pre-trained
machine learning model for invoice data extraction, but will continue to support learning instance
group based-training extraction.
We have released a new set of capabilities on pre-trained models with Document Automation as
part of v.25 release, including a new command package called Document Extraction. IQ Bot
Extraction package will be deprecated starting from the next release Automation 360 v.26, so we
recommend our customers to start leveraging this new Document Extraction package.
For more information about Document Extraction package and instructions on how to move
learning instances to Document Automation, see Move from IQ Bot Extraction package to Document
Automation alla pagina 1657.

Note sulla versione di v.24R2 Automation 360 per EOL Internet
Explorer 11
Data di rilascio: 17 May 2022

This release notes applies to the Automation 360 v.24R2 patch release for Cloud, On-Premises,
Sandbox, and Community Edition users impacted by the Internet Explorer end-of-life (IE EOL) and
who have therefore chosen to convert IE bots.
Cloud, On-Premises, IQ Bot, Sandbox, and Community Edition are on Build 13343.

Nota:  The IQ Bot build does not include any specific updates and is available to match the Control Room
build.

Perché questa versione

Microsoft ha annunciato la fine del ciclo di vita (EOL) di Internet Explorer a partire da giugno 2022 e
consiglia di utilizzare Microsoft Edge o Microsoft Edge in modalità IE. Questa versione contiene pacchetti
certificati su Edge in modalità IE e un Update Bot wizard IE per fornire supporto con l'aggiornamento dei
bots in blocco, in modo da lavorare con Edge in modalità IE. L'imminente EOL di IE potrebbe interessare le
distribuzioni in base al sistema operativo attualmente utilizzato per eseguire i bots.
Fai riferimento alla tabella seguente per i dettagli:

Sistema operativo Microsoft Automation 360 bots

Canale semestrale di Windows 10 Aggiorna i bots per utilizzare un browser
compatibile.
Per un elenco dei browser supportati, consulta
Requisiti del browser per RPA Workspace alla
pagina 866.

Tutti gli altri sistemi operativi supportati Nessun effetto immediato

A partire dall'imminente Automation 360 v.25, ti verrà chiesto di accedere alla Control Room con un
browser supportato alternativo, come Google Chrome o Microsoft Edge (Chromium), anziché tramite
Internet Explorer. Non sarà più possibile accedere alla Control Room da Internet Explorer. Allineandoci alla
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strategia di Microsoft per il supporto dei browser, siamo in grado di fornire funzionalità ottimizzate offerte
dai browser più recenti, come Google Chrome e Microsoft Edge.

Aggiornamento a questa versione

You can update to Automation 360 v.24R2 On-Premises from the following previous releases that are
certified for update:
• v.24 (Build 12350)
• v.23 (Build 11513)
• v.22 (Build 10526)
• v.21 (Build 9664, 9642, 9595)

As Community Edition and Sandbox are Cloud deployments, no manual upgrade is required. These
environments are automatically updated to Automation 360 v.24R2 Build 13343.
If you are not on any of the above certified releases, update Automation 360 to one of the certified
releases (listed previously) before updating to this release.
Per informazioni sull'aggiornamento a questa versione, consulta le seguenti risorse:
• Aggiornamento alla versione di Automation 360 più recente alla pagina 1063
• Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina

1043
• Compatibility with release builds alla pagina 1026

Per gli aggiornamenti più recenti delle estensioni di Automation 360 per Google Chrome, Microsoft Edge e
Mozilla Firefox, vedi Browser extensions for Automation 360 alla pagina 718.

Aggiornamenti Bot Agent

Questa versione include un aggiornamento di Bot Agent facoltativo. Per utilizzare le caratteristiche della
patch v.24R2 di Automation 360, aggiorna l'Bot Agent disponibile con le seguenti build:
• Bot Agent versione 21.200 per build 13343
• Bot Agent version 21.1000.14009 for Build 13331 (On-Premises pre-GA)

Se desideri eseguire i bots esistente, non aggiornare l'Bot Agent a questa versione.
If you have installed the Automation 360 v.24R2 pre-GA patch (Build 13331) with Bot Agent version
21.1000.14009, perform the following steps.
1. Disinstalla la versione pre-GA Bot Agent 21.1000.14009.
2. Installa Bot Agent versione 21.200 per Automation 360 v.24R2 (build 13343).

Importante:  Se hai spostato i bots dall'ambiente UAT (User Acceptance testing) e li hai distribuiti in un
ambiente di produzione (PROD) con Bot Agent versione 21.1000.14009, è necessario aggiornare i pacchetti
con la versione di Bot Agent più aggiornata 21.200.
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Funzionalità Community Edition

Packages

Supporto del browser Microsoft Edge per il package Browser e le variabili finestra
• Le seguenti actions del package Browser ora supportano il browser Microsoft Edge basato su

Chromium:
• Chiudi
• Ottieni codice sorgente
• Vai indietro
• Apri
• Esegui JavaScript

• Nell'opzione Browser, è ora possibile selezionare le schede Microsoft Edge dall'elenco delle
schede attive.

Supporto per l'ultima scheda del browser utilizzata in Browser > Apri  action per
Microsoft Edge e Google Chrome
Ora puoi aprire una pagina web in una nuova scheda o in una scheda esistente utilizzando l'Ultima
scheda del browser utilizzata nei seguenti browser:
• Microsoft Edge
• Microsoft Edge con modalità IE
• Google Chrome

Automatizzazione delle applicazioni Web Java
Ora puoi automatizzare le applicazioni Web Java eseguire su Microsoft Edge Chromium con modalità
IE utilizzando il Registratore > Acquisisci o l'opzione Avvia registrazione.

Tempo di attesa predefinito per il caricamento della pagina nel browser Microsoft Edge
con modalità IE
Quando si automatizza qualsiasi applicazione Web nel browser Microsoft Edge con modalità IE,
il Recorder ora attende 30 secondi per impostazione predefinita per permettere alla pagina web
di caricarsi completamente prima di registrare qualsiasi oggetto sulla pagina, rendendo così il
rilevamento degli oggetti più affidabile.
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Cloud, On-Premises, and Sandbox features

Control Room e Packages

Nuovo Update Bot wizard per Internet Explorer
• Utilizzate il nuovo Update Bot wizard nella Control Room per convertire i bot bots Internet

Explorer esistenti in Microsoft Edge con la modalità IE per assicurare che questi bots convertiti
continuino a funzionare dopo l'EOL di IE.
Update Bot wizard for converting IE bots alla pagina 786

• Come amministratore, puoi abilitare un utente all'uso del Update Bot wizard assegnando le
autorizzazioni della funzione di aggiornamento del nuovo Bot per accedere e convertire un bot
da Internet Explorer a Microsoft Edge con la modalità IE.
Autorizzazioni per le funzioni di un ruolo alla pagina 2694

• Utilizza l'azione Visualizza aggiornamento del bot in un'istanza di conversione del bot per
visualizzare il riepilogo e lo stato di ogni conversione di bot. Puoi rivedere i dettagli dell'azione ai
numeri di linea individuali e intraprendere azioni, se necessario, per i bots che sono in stato non
riuscito o in stato completato con lo stato azione o revisione richiesta.
Visualizza i dettagli di conversione per i bot IE

Automatizzazione delle applicazioni Web Java
Ora puoi automatizzare le applicazioni Web Java eseguire su Microsoft Edge Chromium con modalità
IE utilizzando il Registratore > Acquisisci o l'opzione Avvia registrazione.
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Control Room e Packages

Conversione dei bots Automation 360 con packages specifici del browser utilizzando
Internet Explorer in Microsoft Edge con modalità IE
Puoi convertire i bots che utilizzano Internet Explorer in Microsoft Edge Chromium con la modalità
IE per i seguenti packages:
• Recorder
• Browser
• Application
• Simulate keystrokes
• Screen
• Mouse
• Window
• OCR
• App Integration
• Image Recognition
• If
• Loop
• Wait

Per convertire questi bots, utilizza Update Bot wizard nella scheda Amministrazione >
Aggiornamento bot nella Control Room.
Update Bot wizard for converting IE bots alla pagina 786
Le seguenti proprietà di packages e actions basati su browser sono aggiornate dal browser Internet
Explorer a Microsoft Edge con modalità IE:
• Bots creati utilizzando la finestra del browser o dell'applicazione, il titolo della finestra e il

percorso dell'applicazione
• Valore predefinito della variabile finestra, titolo della finestra e percorso dell'applicazione della

finestra
• Variabili del browser e titolo del browser

Supporto del browser Microsoft Edge per il package Browser e le variabili finestra
• Le seguenti actions del package Browser ora supportano il browser Microsoft Edge basato su

Chromium:
• Chiudi
• Ottieni codice sorgente
• Vai indietro
• Apri
• Esegui JavaScript

• Nell'opzione Browser, è ora possibile selezionare le schede Microsoft Edge dall'elenco delle
schede attive.
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Control Room e Packages

Supporto per l'ultima scheda del browser utilizzata in Browser > Apri  action per
Microsoft Edge e Google Chrome
Ora puoi aprire una pagina web in una nuova scheda o in una scheda esistente utilizzando l'Ultima
scheda del browser utilizzata nei seguenti browser:
• Microsoft Edge
• Microsoft Edge con modalità IE
• Google Chrome

Tempo di attesa predefinito per il caricamento della pagina nel browser Microsoft Edge
con modalità IE
Quando si automatizza qualsiasi applicazione Web nel browser Microsoft Edge con modalità IE,
il Recorder ora attende 30 secondi per impostazione predefinita per permettere alla pagina web
di caricarsi completamente prima di registrare qualsiasi oggetto sulla pagina, rendendo così il
rilevamento degli oggetti più affidabile.

Funzionalità di migrazione

Scansione di bots che utilizzano Microsoft Internet Explorer
Ora puoi utilizzare il Bot Scanner per effettuare la scansione e identificare bots Internet Explorer.
Puoi anche analizzare il rapporto generato da Bot Scanner per ottenere statistiche di utilizzo di
Internet Explorer utilizzate nei bots.
Scansione di bots che usano Internet Explorer alla pagina 1159 | Analyze report for Internet Explorer bots
alla pagina 783 | Messaggi sulla conversione o scansione Internet Explorer alla pagina 1336
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Funzionalità di migrazione

Packages e actions
Ora puoi migrare e convertire bots Internet Explorer da Enterprise 11 o Enterprise 10 a Automation
360 con Microsoft Edge con modalità IE per i seguenti packages e actions:
• App Integration
• Delay
• IF/ELSE e Loop
• Image Recognition
• Launch Website
• Manage Window Controls
• Schermata MetaBot
• Mouse
• Object Cloning

Sono supportate le modalità Riproduzione immagine e Riproduzione coordinate. La
modalità Riproduzione coordinate supporta l'azione clic del mouse con successiva pressione
tasti.

• OCR
• Open Program/File
• Screen
• Simulate keystrokes
• Wait

Support for Wait for condition, Wait for screen change, and Wait for window actions
• Web Recorder
• Windows Actions

Per ulteriori informazioni, consulta Mappatura dei pacchetti per la migrazione alla pagina 1247.
Per migrare e convertire bots, accedi ad Amministrazione > Migrazione > Esegui la
migrazione di bot, quindi seleziona l'opzione Conversione dei bot costruiti usando Internet
Explorer in Edge con la modalità Internet Explorer nella Control Room.
Le seguenti proprietà di comandi e actions basati su browser sono aggiornate da Internet Explorer
a Microsoft Edge con la modalità IE:
• Bots creati utilizzando la finestra del browser o dell'applicazione, il titolo della finestra e il

percorso dell'applicazione
• Valore predefinito della variabile finestra, titolo della finestra e percorso dell'applicazione della

finestra

Nota:  Bots che usano variabili di tipo valore non sono aggiornati a Microsoft Edge. Occorre
prima abilitare le impostazioni di configurazione nel menu del package Legacy Automation per
aprire bots creati usando Internet Explorer in modalità di compatibilità Microsoft Edge.

• Variabili del browser e titolo del browser

Conversione di bots IE in Microsoft Edge con modalità IE
Quando si esegue la migrazione dei bots da Enterprise 10 o Enterprise 11, è possibile utilizzare
la nuova opzione Conversione dei bot costruiti usando Internet Explorer in Edge con la
modalità Internet Explorer in Bot Migration Wizard per convertire i bots da Internet Explorer a
Microsoft Edge con modalità IE.
Migrazione dei bots di Enterprise alla pagina 1216
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Funzionalità di migrazione

Cronologia e versione aggiornata per i bots migrati
Nel Bot Migration Wizard, quando si esegue la migrazione dei bots Enterprise 10 o Enterprise
11, la cronologia delle versioni viene ora aggiornata per mostrare che si tratta di un bot migrato
(il commento dell'archiviazione mostra che il bot è stato migrato dalla versione Enterprise 10 o
Enterprise 11). Si può usare questo commento di archiviazione per identificare la versione del bot
migrata.
Bot Migration Wizard alla pagina 1213

Correzioni

The following fixes are available for Cloud, On-Premises, and Sandbox:

ID caso Service Cloud Descrizione

01784593 Ora puoi eseguire correttamente bots migrati anche quando è
presente il segno del dollaro ($) come valore nel campo Variabili
utente. Bot Scanner non mostra più un errore di pre-elaborazione.

-- Quando si automatizzano applicazioni Web in esecuzione
su Microsoft Edge Chromium con modalità IE o Internet
Explorer, Recorder ora acquisisce l'oggetto dalla scheda browser
attualmente selezionata. In precedenza, Recorder acquisiva
l'oggetto dall'ultima scheda utilizzata.

01189873 After migration, when you use the Browser > Open action
to open a URL that has a space character, use the Browser >
Download files action to download the file from the specified
URL, and then run the bot, the bot now opens the URL in a single
tab and downloads the file from the specified URL.
Previously, when the specified URL had a space character, the bot
split the URL and opened it in two separate tabs.

Limitazioni e comportamenti noti

The following limitations apply to Cloud,On-Premises, and Sandbox:
• When you execute a stored procedure with name parameter arguments that resides in another

database in the SQL Server, the bot displays an error because of the JDBC driver issue with executing a
stored procedures with name parameters of another database in the same SQL instance.
Soluzione: When you add parameters to provide an input parameter or configure an output parameter,
ensure you do not enter any value in the Parameter name field. The bot will not encounter any
error when executing the stored procedure because the Database package considers blank values as
indexing.

• Anche quando il numero di programmi elencati nella pagina Programmi della Control Room è inferiore
(per esempio, cinque o sei programmi), potresti ricevere il seguente errore a causa di un timeout della
query: Si è verificato un problema imprevisto. Si tratta di un problema esistente relativo
alle prestazioni del database della Control Room.
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• Ci sono altre limitazioni e comportamenti che si applicano a bots migrati da Enterprise 11 a Automation
360 e a bots Automation 360 eseguiti su Internet Explorer e convertiti in Microsoft Edge con modalità
IE. Per ulteriori informazioni, consulta Limitazioni e comportamenti noti alla pagina 777.

• When you use the Browser > Close action to close a tab or a window opened in the Microsoft Edge
browser, if only one Microsoft Edge browser window is open, the bot encounters the following error:
Error occurred while closing the tab

Soluzione: Vedi Configure Microsoft Edge browser settings when Close action of Browser package encounters
an error (A-people login required)

• When you use the Browser > Open action to open network URLs that start with two backslash (\\)
characters in the Google Chrome, Microsoft Edge, or Mozilla Firefox browser, the URLs might not open
properly.
Soluzione: Replace the two backslash (\\) characters with file:// protocol.

• When you use the Browser > Open action, select New tab or Existing tab option to open a specific
webpage in Microsoft Edge with IE mode, the bot might throw an error after opening the webpage.
Soluzione: Use any of the following workarounds based on specific scenarios:
• Option 1: Add Try/Catch block around the Open action and ignore the exception as the website

opens.
• Option 2: In the Browser > Open action, select the New window option instead for such

websites.

• When you use the New window option in the Browser > Open action with the 3.4.x version of the
Browser package to open a URL with arguments, the bot might not perform the specific action as the
3.4.x version of the Browser package does not support argument flags.
Soluzione: Use any version other than the 3.4.x version of the Browser package to automate.

Vedi anche queste risorse:
• Microsoft Internet Explorer EOL overview alla pagina 766
• Microsoft Internet Explorer 11 EOL FAQ alla pagina 770

Concetti correlati
Microsoft Internet Explorer 11 EOL FAQ alla pagina 770
Microsoft has announced end-of-life (EOL) for Internet Explorer beginning June 2022 and recommends
using Microsoft Edge or Microsoft Edge in Internet Explorer (IE) mode. Ciò influirà sulle automazioni (bots)
a seconda del sistema operativo in cui sono eseguiti i bots.
Microsoft Internet Explorer EOL overview alla pagina 766
Microsoft has announced retiring Internet Explorer (IE) for certain versions of Windows operating systems
and recommends impacted users to move their apps or websites running on IE to Microsoft Edge with IE
mode.
Informazioni correlate
Enterprise 11 and upcoming Internet Explorer 11 EOL FAQ

Note sulla versione Automation 360 v.24
Data di rilascio:08 aprile 2022

Riesamina le novità e le modifiche apportate e le correzioni e le limitazioni della versione Automation 360
v.24 (Build 12350).

Importante:  Abbiamo aggiornato Automation 360 v.24 (Build 12350) per includere le correzioni per i
seguenti problemi:
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• Dopo la migrazione, quando si eseguivano i bots migrati, veniva visualizzato un errore per le variabili
all'interno di virgolette doppie (" ") (ID caso Service Cloud: 01802575, 01803323, 01803800, 01804121,
01804820).

• Quando facevi clic sull'icona AARI, la Control Room veniva visualizzata al posto della schermata di
accesso AARI Assistant (ID caso Service Cloud: 01803979).

• Migrazione
11.x e 10.x | solo 11.x | solo 10.x

• RPA Workspace
Novità | Cosa è cambiato | Correzioni | Limiti

• AARI
Novità | Cosa è cambiato | Correzioni | Limiti

• Discovery Bot
What's new | Fixes | Limitations | Feature Deprecation

• IQ Bot
Novità | Correzioni | Limiti

• Bot Insight
Cosa è cambiato | Correzioni | Limitazioni

Aggiornamento a questa versione

Puoi anche eseguire l'aggiornamento a Automation 360 v.24 dalle tre versioni precedenti (ovvero dalle
versioni n-3, dove n si riferisce alla versione più recente). Le seguenti versioni precedenti sono certificate
per l'aggiornamento a questa versione:
• v.23 (Build 11513)
• v.22 (Build 10526)
• v.21 (Build 9664, 9642, 9595)

Puoi passare direttamente alla versione v.24 da una qualsiasi di queste build (vedi Aggiornamento alla
versione di Automation 360 più recente alla pagina 1063). Se non utilizzi una versione n−3, puoi aggiornare
Automation 360 a una delle tre versioni certificate (sopra indicate) prima di passare a questa versione.
• Se effettui l'aggiornamento direttamente a questa versione da Automation 360 On-Premises v.21,

rimuovi i seguenti file e cartelle Bot Agent:
• C:\Windows\System32\config\systemprofile\AppData\Local\AutomationAnywhere

\AA-DB.mv.db
• C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-resources

• Prima dell'aggiornamento a questa versione da Automation 360On-Premises v.22, consulta le
considerazioni in Aggiornamento alla versione di Automation 360 più recente alla pagina 1063.

Importante:  Questa versione include un aggiornamento di Bot Agent facoltativo. Per utilizzare le nuove
funzionalità della versione v.24 (compresi gli aggiornamenti ai packages Migrazione Bot, Browser, DLL,
Process Discovery e Recorder), aggiorna l'Bot Agent disponibile con questa versione. Tuttavia, se desideri
eseguire i bots esistenti, non aggiornare l'Bot Agent a questa versione.

Per informazioni sull'aggiornamento a questa versione, consulta le seguenti risorse:
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• Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina
1043

• Compatibility with release builds alla pagina 1026

Per gli aggiornamenti più recenti delle estensioni di Automation 360 per Google Chrome, Microsoft Edge e
Mozilla Firefox, vedi Browser extensions for Automation 360 alla pagina 718.

Important:  Questa versione include nuovi packages di comandi in cui la libreria Apache log4j2 non
è più inclusa. Tuttavia, i precedenti packages di comandi di Automation 360 v.23 e versioni precedenti
potrebbero comunque includere la libreria log4j2. Per utilizzare i packages di comandi senza libreria log4j2
inclusa, ti consigliamo di utilizzare i packages più recenti di Automation 360 v.24 per le tue attività.

Migrazione

Funzionalità di Enterprise 11 e Enterprise 10

Migrazione Control Room self-service
Ora puoi gestire il processo di provisioning della migrazione con le funzionalità di migrazione
automatica. Puoi anche scegliere tra la migrazione manuale e quella automatica.
Migrazione della Control Room self-service alla pagina 1015

Miglioramento della migrazione di variabili Credential Vault
La migrazione è ora supportata quando variabili Credential Vault vengono passate da una logica
MetaBot ad un'altra logica MetaBot per i seguenti comandi:
• IF > Logica riuscita
• IF > Logica non riuscita
• Avvia gestione errori > Esegui logica

Ora è possibile migrare con successo bots Enterprise 11 che usano wscript.exe a 32 bit
all'architettura a 64 bit, senza errori di eccezione. Questo miglioramento aiuta a eseguire VBScript
con successo.

Migrazione di MetaBot con logica padre e figlio con Logic rinominata
Ora è possibile migrare un MetaBot con Logic (padre) che include una Logic (figlio) rinominata.
Se una Logic figlio viene rinominata dopo essere stata mappata alla Logic padre, la mappatura di
questa Logic padre viene ora migrata con il nuovo nome.
Questo miglioramento si applica ai comandi seguenti:
• IF > Logica riuscita
• IF > Logica non riuscita
• Else If > Logica riuscita
• Else If > Logica non riuscita
• Gestione errori > Esegui logica
• Esegui logica
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Funzionalità di Enterprise 11 e Enterprise 10

Migrazione quando MetaBot e Logic hanno lo stesso nome
Ora è possibile migrare con successo i bots Enterprise 11 quando il nome del MetaBot e quello della
cartella delle risorse o il nome della Logic all'interno del MetaBot sono gli stessi. Il nome della Logic
ha il suffisso -bot. Il suffisso viene aggiunto solo quando la Logic o la cartella si trovano allo stesso
livello gerarchico del MetaBot.
• Se la Logic o la cartella delle risorse di un bot esistente vengono rinominate, la Logic viene

rinominata con il successivo numero disponibile. Per esempio, -botn, dove n indica il successivo
numero disponibile. Inoltre, viene visualizzato un messaggio di azione richiesta.

• Se un MetaBot o una Logic richiamano una Logic o TaskBots rinominati, il percorso del comando
viene aggiornato per includere il nuovo nome.

• Se una Logic, un MetaBot o un nome di cartella sono presenti con un nuovo nome, il nome del
bot esistente viene sovrascritto.
Messaggi di migrazione alla pagina 1302

Vista consolidata dei bots migrati e relativo stato
Utilizza la scheda Panoramica in Control Room per ottenere una vista consolidata dello stato
dei bots migrati. Visualizza lo stato generale della migrazione dei bot per tutti i bots migrati con
successo, per quelli per i quali la migrazione non è riuscita e per quelli che richiedono una revisione
o un'azione. Hai anche la possibilità di rieseguire la migrazione su bots selezionati visualizzando in
tal modo la cronologia di ciascun bot che ha subito più migrazioni.
Bot Migration Wizard alla pagina 1213

Funzionalità esclusive di Enterprise 11

Aggiornamento alle variabili AAApplicationPath, CurrentDirectory e AAInstallationPath
Se il bot migrato contiene le variabili $AAApplicationPath$, $CurrentDirectory$ o $AAInstallationPath
$ in un qualsiasi percorso di file o cartella, non viene più eseguita la convalida del percorso assoluto
durante la migrazione. Inoltre, la variabile temporanea ($m-string-start-in-path$) non viene
creata e assegnata al bot migrato per la convalida. Di conseguenza, le dimensioni di un bot migrato
sono ridotte, con conseguenti miglioramenti delle prestazioni del bot.

Miglioramento per la migrazione di bots con il comando E-mail Connetti
Quando si migrano bots Enterprise 11 che contengono i comandi E-mail > Connetti e E-mail >
Invia configurati per il server EWS, il campo Cloud di Azure è impostato su Azure globale e il
campo Tipo di autenticazione è impostato su OAuth2-Silente precedentemente denominato
OAuth2.
OAuth2 ora supporta due modalità: Silente e Interattiva.
Using Connect action for Email alla pagina 1497

Migrazione di bots con timeout configurato per l'invio di richieste REST e SOAP
Il valore di timeout configurato in Enterprise 11 per l'invio di richieste REST e SOAP è ora migrato
a Automation 360 come parte dei valori globali (AARestTimeOut e AASoapTimeOut). Il valore
predefinito di timeout è impostato a 60000 ms in Automation 360. Puoi aggiornare questo valore se
il REST Web Service richiede più tempo per ricevere una risposta.
REST Web Service package alla pagina 1777 | Esempio di utilizzo dell'azione Servizio Web SOAP alla
pagina 2076
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Funzionalità esclusive di Enterprise 10

Migrazione di bots Enterprise 10 nuovi o modificati a Automation 360 (ID caso Service
Cloud 00719524)
È ora possibile migrare bots Enterprise 10 nuovi o modificati a Automation 360 dopo una
migrazione precedente. È ora disponibile una nuova utilità di esportazione che permette di
esportare questi bots nuovi e modificati dall'archivio Control Room Enterprise 10. È poi possibile
importare successivamente i bots esportati in Automation 360 utilizzando Bot Lifecycle Management
(BLM) e migrarli infine utilizzando la Bot Migration Wizard.
Migrazione di Enterprise 10 bots nuovi o aggiornati su Automation 360 alla pagina 1210

RPA Workspace

Novità

Aggiornamenti dell'Bot Agent e disponibilità anticipata dei packages
A partire da questa versione, puoi scegliere o saltare alcuni aggiornamenti dell'Bot Agent e iniziare
a utilizzare i packages non appena le nuove versioni dei package sono disponibili a livello generale,
indipendentemente dalla tua regione.
Gli aggiornamenti obbligatori e facoltativi dell'Bot Agent che supportano nuovi packages o gli
aggiornamenti dei packages saranno resi disponibili trimestralmente.
In precedenza, gli aggiornamenti dell'Bot Agent erano disponibili automaticamente attraverso
i pool di dispositivi dell'utente e non influivano sull'esecuzione del bot. In alcuni scenari di
distribuzione ampi e complessi, questi aggiornamenti erano difficoltosi ma non potevano essere
saltati. (Gli esempi includono casi in cui i pool di dispositivi erano distribuiti tramite Amazon
Machine Image (AMI) di dispositivi standard su programmi separati che richiedevano maggiore
coordinamento, processi di gestione delle modifiche e approvazioni nell'ambiente utente per
l'aggiornamento dell'Bot Agent). Ora è possibile saltare un aggiornamento facoltativo e passare al
successivo aggiornamento obbligatorio dell'Bot Agent in quanto Automation 360 inizierà a fornire la
compatibilità con le versioni precedenti con l'Bot Agent ogni sei mesi.
Inoltre, con ogni versione puoi iniziare a utilizzare i packages più recenti subito dopo il rilascio di
nuove versioni dei package. Per gli utenti di Automation 360 Cloud, gli aggiornamenti dei package
sono ora disponibili in modo asincrono in tutte le regioni, pertanto puoi iniziare a utilizzare i
packages più recenti nella versione corrente della Control Room anche prima che l'aggiornamento
della Control Room sia reso disponibile per la tua regione.
Compatibility with release builds alla pagina 1026

Creazione di utenti per login multipli
Ora sarai in grado di creare un utente per login multipli. A un utente per login multipli sono
consentite più sessioni alla Control Room tramite API.
Utente multi-login alla pagina 2690 |

Ulteriori operazioni con Microsoft Edge Chromium
Ora è possibile utilizzare l'estensione per il browser Microsoft Edge Chromium per quanto segue:
• Configurazione del proxy Bot Agent
• Popolamento automatico delle credenziali del dispositivo

Requisiti del browser per RPA Workspace alla pagina 866
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Novità

Riduzione dei tempi di risposta
Ora puoi ridurre i tempi di risposta per la raccolta delle informazioni relative ai problemi grazie
all'acquisizione di file di log dal dispositivo Bot Runner. Puoi salvare i file di registro utilizzando il
nuovo comando -collectlogs con l'utilità di diagnostica Bot Agent.
Esecuzione di controlli diagnostici Bot Agent alla pagina 1048

Impatto del cambiamento di policy di Google Chrome sull'Bot Agent
A partire da Google Chrome versione 101, Google Chrome eliminerà l'accesso diretto agli endpoint
di rete privati dai siti web pubblici secondo la specifica Private Network Access (PNA) per gli URL
che utilizzano https. Per mitigare l'impatto, a partire da questa versione sono state aggiunte
all'Bot Agent delle intestazioni di risposta per permettere la comunicazione con la Control Room
sui browser Google Chrome. Ciò garantisce che operazioni come la registrazione di dispositivi e la
registrazione, riproduzione o distribuzione dei bot non risentano di questo cambiamento.

Miglioramenti al AISense Recorder
Ora è possibile utilizzare AISense Recorder per automatizzare le applicazioni che usano il
giapponese e una combinazione di interfacce giapponesi e inglesi.
AISense per la registrazione di attività da applicazioni remote alla pagina 1965

Opzione di tempo di attesa nei packages SOAP Web Service e REST Web Service  (ID
caso Service Cloud: 00756730, 00792793, 01255869, 01753287)
Quando si crea un bot, è ora possibile impostare un valore di timeout per le actions nelle richieste
REST e SOAP. Per indicare il tempo per cui un bot dovrebbe attendere una risposta dal server
prima del timeout, è possibile impostare un tempo di attesa (in millisecondi) nel campo Attendi il
completamento delle azioni. È possibile inserire un numero o una variabile o fornire un valore
globale.

Formattazione del testo con il nuovo editor HTML nel package Email
Nel package Email, quando si utilizzano le actions Invia, Rispondi e Inoltra, è ora possibile
creare e personalizzare il layout e il corpo delle e-mail utilizzando il nuovo editor di design HTML.
Usa la barra degli strumenti dell'editor per apportare modifiche al testo, come applicare il grassetto,
il corsivo e altri effetti di formattazione, inserire collegamenti e cambiare il carattere e le dimensioni
del testo. È possibile copiare il contenuto dall'editor di design e incollarlo in altre finestre.

Il package Task Bot ora supporta il passaggio della variabile Finestra al bot figlio (ID
caso Service Cloud: 00691890, 00804359, 01258948, 01764292)
Nell'action Esegui del package Task Bot, quando si selezionano i campi Valori di input e si
immettono i valori o le variabili da passare al bot figlio, è ora possibile scegliere la variabile tipo
Window e passarla dal bot padre al bot figlio.

Nuova opzione nel campo Tipo di contenuto del package REST Web Service (ID caso
Service Cloud: 00666852, 00789910, 00771194, 00785116, 00825945, 01762199)
Ora è possibile utilizzare l'opzione multiparte/dati modulo per caricare file e dati tramite REST
Web Service. Il tipo di contenuto multiparte/dati-modulo può essere usato per inviare elementi di
modulo contenenti file, dati non-ASCII e dati binari. Questa opzione è disponibile per actions come
POST, PUTe PATCH.

© 2023 Automation Anywhere. All rights reserved.     272



    Automation Anywhere - Learn

Novità

Opzione delimitatore personalizzato nel package SOAP Web Service
Per risposte specifiche a XPath, è ora possibile utilizzare l'opzione delimitatore personalizzato per
delimitare il contenuto di ritorno dalla risposta SOAP. Nel campo Delimitatore personalizzato, è
possibile immettere un carattere o una variabile e l'output della risposta delimitata sarà una stringa
completa.

Nuova opzione nell'action Esegui funzione del package DLL (ID caso Service Cloud:
00830568, 01063654, 01259336, 01767965)
Nell'action Esegui funzione del package DLL, quando la DLL C# interagisce con l'API di Windows
per eseguire operazioni relative al sistema, come la pressione dei tasti, il clic del mouse o il cambio
di finestra, viene visualizzata occasionalmente una finestra intermedia (AAZeroSizeForm) che
interrompe l'operazione dell'utente quando il bot è in esecuzione. In alcuni casi, la funzione DLL
non interagisce con l'API di Windows per eseguire actions come la pressione di un tasto, il clic del
mouse o il cambio di finestra, sull'interfaccia utente del sistema operativo attraverso la funzione
DLL. In questi casi, è possibile selezionare la casella di controllo Esegui funzione in background
per bypassare la finestra intermedia (AAZeroSizeForm) ed eseguire la DLL C# nell'applicazione
console senza il modulo. Questa funzionalità aiuta anche a migliorare le prestazioni di esecuzione
della DLL se la casella di controllo Esegui funzione in background è selezionata.

Scorrimento automatico supportato in Bot editor (ID caso Service Cloud: 00730747)
Quando si creano o modificano bots con un gran numero di righe di codice e quando si trascinano
actions su e giù per la pagina, la pagina scorre ora automaticamente verso l'alto o verso il basso di
conseguenza. Questa funzionalità è supportata in entrambe le viste Flusso ed Elenco.

Configurazione del timeout della sessione nelle impostazioni Control Room  (ID caso
Service Cloud: 00765320)
Ora puoi configurare la durata del timeout sessione nelle impostazioni della Control Room, in modo
che la tua sessione Web non scada, ad esempio mentre stai creando un bot. A seconda della durata
del timeout configurata, la sessione scadrà solo dopo il numero specificato di minuti di inattività,
evitando in tal modo la perdita del lavoro a causa di un timeout anticipato.

Nuovo package JSON
Utilizza il package JSON per automatizzare i dati JSON. È ora possibile estrarre le informazioni
richieste dal testo o dal file JSON e utilizzare direttamente i valori nel bot.
package Json alla pagina 1666

Nuova opzione nell'action Cattura del package Error handler (ID caso Service Cloud:
00766117)
Nel package Error handler, ora puoi ignorare gli errori delle actions all'interno del blocco Cattura
utilizzando l'opzione Cattura > In caso di errore, continua con l'azione successiva. Quando
selezioni la casella di controllo In caso di errore, continua con l'azione successiva, anche se
esiste un errore da un'action nel blocco Cattura, non viene lanciata alcuna eccezione e il bot ignora
l'errore e continua con l'azione successiva.

Nota:  Questo miglioramento si applica a tutte le actions contenute all'interno del blocco Cattura.
Per esempio, se esiste un'action Prova/Cattura all'interno dell'action Cattura principale e
la casella di controllo dell'action Cattura principale è selezionata, qualsiasi errore da actions
all'interno del blocco annidato sarà ignorato.
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Novità

Miglioramenti all'action Connetti del package Email (ID caso Service Cloud: 00830611,
01264796, 00788467)
• Ora puoi connetterti a un server EWS ospitato sul cloud Azure US GCC High.
• L'action consente ora agli utenti Azure federati di connettersi a un server EWS in modalità

Automazione assistita.

Using Connect action for Email alla pagina 1497

Miglioramento del package Stringa
Nell'action Estrai testo del package Stringa ,quando si usa l'opzione Dopo o Prima e/o dopo, è
ora possibile estrarre una sottostringa da una stringa sorgente specificata presente tra 1 e 999999
volte in un file.

Ricerca di file per data specifica
È ora possibile cercare i file creati o modificati in una data specifica utilizzando la nuova opzione In
data disponibile nella condizione Data file di vari packages.
Puoi usare questa funzione con i seguenti packages e actions:
• File package

• Copia file desktop action
• Elimina action
• Stampa action
• Stampa più file action
• Rinomina action

• package cartella
• Copia action
• Elimina action
• Rinomina action

• If > Condizione di data del file
• Loop > While > Condizione di data del file

Nuova action nel package Excel advanced (ID caso Service Cloud: 01263892, 01782290)
Quando si eseguono actions in un foglio di lavoro di Microsoft Excel, è ora possibile disabilitare o
abilitare l'aggiornamento della schermata in tempo reale utilizzando la nuova action Disabilita o
abilita l'aggiornamento dello schermo in tempo reale del package Excel advanced. Questa
action è utile per migliorare le prestazioni delle automazioni basate su Excel in fase di esecuzione
quando si tratta di grandi insiemi di dati.
Worksheet operations in Excel advanced alla pagina 1542

Supporto per la copia di metadati da un bot a un altro
È ora possibile copiare file di immagini e metadati da un bot all'altro usando l'opzione Copia negli
appunti condivisi.
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Novità

Aggiunta di capacità di estrazione di documenti ai bots
Ora puoi fare in modo che i bots si connettano al tuo account di servizio Google Cloud, inviino
documenti a un processore specifico e recuperino i dati estratti in formato JSON usando le actions
contenute nel package IA Google Document.
Google Document AI package alla pagina 1610

Utilizzo delle condizioni Recorder in Microsoft Edge basato su Chromium con modalità
Internet Explorer (IE)
Ora puoi utilizzare le condizioni Recorder L'oggetto esiste e L'oggetto non esiste in Microsoft
Edge basato su Chromium con modalità IE per i seguenti packages:
• Loop > Condizione While
• Wait > Condizione Attendi
• If package

Utilizzo di formati data e ora personalizzati
Utilizza le seguenti convenzioni per specificare formati di data e ora personalizzati e convertire un
valore di data e ora:
• G: Specifica un giorno in un anno come G o GG.
• a: Specifica un marcatore AM/PM per il formato orario a 12 ore.

Datetime formats alla pagina 1475

Supporto del browser Internet Explorer per il package Browser e le variabili finestra
• Le seguenti actions del package Browser ora supportano il browser Internet Explorer:

• Apri
• Chiudi
• Vai indietro
• Ottieni codice sorgente

• Nell'opzione Browser, è ora possibile selezionare le schede Internet Explorer dall'elenco delle
schede attive.

Browser package alla pagina 1425

Miglioramenti al Datetime package
L'opzione Variabile nell'action Data/ora > Assegna è ora migliorata e suddivisa in due opzioni:
• Data/ora: Permette di selezionare manualmente la data e l'ora insieme al fuso orario e di

assegnarli a una variabile Data/ora.
• Variabile: Permette di selezionare la variabile Datetime o altre variabili che possono avere

Datetime come sottotipo, come le variabili Dizionario, Record ed Elenco.

Utilizzo dell'azione Assegna alla pagina 1473
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Miglioramenti al Recorder package
È ora possibile acquisire e automatizzare gli oggetti all'interno di un IFrame interdominio che ha
più IFrame con la stessa origine del frame e IFrame caricati in fase di esecuzione nei browser
Chromium Google Chrome e Microsoft Edge. Puoi farlo utilizzando Registratore > Acquisisci
o l'opzione Avvia registrazione. Questo supporto è disponibile anche per le estensioni Google
Chrome offline.
Pacchetto Recorder alla pagina 1751

Supporto per finestre a comparsa e finestre di dialogo nel browser Google Chrome,
Microsoft Edge Chromium e Mozilla Firefox (ID caso Service Cloud: 00762207, 00769773,
00781196, 00786646, 00777907, 00795677, 00785995,00808600, 00811044, 00767486, 01282172,
01286665, 01256750, 01762040)
Durante l'automazione di una pagina Web sui browser supportati, ora puoi acquisire finestre pop-
up, finestre di dialogo di avviso, finestre di dialogo di conferma e finestre di dialogo di richiesta.
Puoi farlo utilizzando Registratore >  Acquisisci o l'opzione Avvia registrazione.
Pacchetto Recorder alla pagina 1751

Recupero del codice sorgente di un iFrame nel browser Google Chrome
Ora puoi estrarre il codice sorgente di un iFrame nel browser Google Chrome utilizzando l'action
Browser > Ottieni codice sorgente. Per acquisire questi iFrame, puoi utilizzare la nuova opzione
Acquisisci oggetto.

Nota:  La funzionalità Acquisisci oggetto è facoltativa e viene utilizzata solo per acquisire il
codice sorgente di un iFrame.

Esegui JavaScript all'interno di un iFrame nel browser Google Chrome
Ora puoi eseguire JavaScript in una pagina che contiene iFrame nel browser Google Chrome
utilizzando l'action Browser >  Esegui JavaScript. Puoi utilizzare la nuova opzione Acquisisci
oggetto per acquisire gli iFrame sui quali desideri eseguire JavaScript.

Nota:  La funzionalità Acquisisci oggetto è facoltativa e viene utilizzata solo per eseguire
Javascript all'interno di un iFrame.

Supporto di Sessione globale per il package Excel basic
• L'opzione Sessione globale è ora supportata per il package Excel basic. Utilizza l'opzione

Sessione globale per condividere una sessione di Microsoft Excel tra più bots in modo da poter
utilizzare lo stesso foglio di lavoro Excel tra questi bots.

• Il campo Nome sessione esistente è ora rinominato Crea sessione Excel.

Using the Open action for Excel basic alla pagina 1531

Variabile predefinita per il contenimento di dati di tipo numerico
Quando si realizza o si testa un bot, ora è possibile utilizzare la variabile numerica predefinita
SampleNumber, inclusa nella tavolozza Variabili.

Nota:  La variabile numerica predefinita è disponibile solo nei nuovi bots.
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Esportazione e importazione di file protetti da password
Per migliorare la sicurezza fornendo protezione contro l'accesso non autorizzato e la modifica
malevola e proteggere inoltre la privacy, le funzioni di esportazione e importazione sono state ora
migliorate per includere l'opzione password. Con questa funzionalità puoi ora eseguire le operazioni
seguenti:
• Impostare una password per i file che vuoi esportare dalla tua Control Room.
• Importare il file esportato protetto da password nella tua Control Room.

Esporta bots alla pagina 2835 | Importa bots alla pagina 2837

Nuove opzioni in configurazione Git (ID caso Service Cloud: 00782957, 00837059, 00687394,
00783715, 00714059, 00659476, 00749755, 00786233, 00748166, 00776417)
Ora puoi eseguire le azioni seguenti per la configurazione Git:
• Scegliere il metodo di autenticazione HTTPS o SSH per impostare la configurazione Git. Il

metodo di autenticazione SSH è più sicuro perché l'autenticazione è basata su una coppia di
chiavi pubbliche e private.

• Specificare il ramo in cui vuoi spingere i tuoi commit di Git. Questo aiuta il coordinamento del
team e la gestione del flusso di lavoro.

• Connettiti all'archivio Git tramite un server proxy.

Configure a remote Git repository in Control Room alla pagina 2754 | Ripristino di bots da archivio Git
alla pagina 2761

Force push ora è un'impostazione di configurazione per l'integrazione git nella Control
Room (ID caso Service Cloud: 00683762)
Ora puoi configurare Git push in modo che sia dotato o no del contrassegno force push. In
precedenza, l'aggiornamento di un Git remoto dalla Control Room funzionava esclusivamente come
un force push. Force push è l'impostazione consigliata e ottimale.

Supporto per Azure DevOps (On-Premises o Cloud) Git per l'autenticazione SSH (ID caso
Service Cloud: 00652012, 00690526)
Ora puoi utilizzare il metodo di autenticazione SSH o HTTPS per connetterti ad Azure DevOps
(On-Premises o Cloud) Git tramite la Control Room per archiviare un bot e i relativi file dipendenti
nell'archivio remoto di Azure DevOps Git.
Connect to Azure DevOps Git from Control Room alla pagina 2757

Vulnerabilità Spring Core - CVE-2022-22965 (01793279, 01793398,
01793497,01793679,01794189)
Aggiornata allo Spring Framework con la patch per la vulnerabilità CVE - CVE-2022-22965.
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Controlli di convalida della migrazione per le impostazioni predefinite del dispositivo
La convalida dei prerequisiti per la migrazione convalida ora se i Bot Runners selezionati per la
migrazione dei bot hanno il dispositivo predefinito impostato. Se il dispositivo predefinito non è
impostato, allora la migrazione dei bot non può procedere e il rapporto di convalida riporta un
errore di convalida. Il rapporto mostra anche gli specifici dispositivi Bot Runner che non hanno un
dispositivo predefinito.
Si noti che la migrazione dei bot non può usare dispositivi selezionati in fase di esecuzione.

Il rapporto sulla migrazione di Bot mostra il bot migrato con azioni e revisioni richieste
Il rapporto sulla migrazione dei bot ora elenca separatamente i bots che potrebbero richiedere
un'azione o una revisione dopo la migrazione. Questa funzione permette di visualizzare la lista
di bots che richiederanno azioni o revisioni e di pianificare di conseguenza i passi successivi alla
migrazione.

Migrazione di bots 11.x con barra nel percorso di file e cartelle (ID caso Service Cloud
00808534)
Ora è possibile migrare bots Enterprise 11 che includono una barra nel percorso utilizzato nell'action
File e cartella. In precedenza, nel percorso era supportata solo la barra rovesciata e quindi
l'utente non poteva creare una cartella su SharePoint.

Ora è possibile migrare manualmente bots Enterprise 11 anche quando la cartella I miei
 MetaBot non è presente nella Control Room poiché questa cartella non viene più convalidata
durante la migrazione.

Gestione utenti avanzata
Ora puoi visualizzare l'attività dei bots avviata da altri utenti dalle cartelle per le quali hai le
autorizzazioni di esecuzione e programmazione.

Miglioramenti delle impostazioni di validità della chiave API (ID caso Service Cloud:
00543590, 00719480, 01373359)
Ora puoi aumentare la durata della validità delle chiavi API a 9999 giorni dalle impostazioni Control
Room per l'autenticazione. In precedenza, la durata della validità delle chiavi API era di 45 giorni.
Con questo miglioramento, un amministratore Control Room non ha bisogno di rigenerare la chiave
API ogni 45 giorni per autenticare API Automation 360.

Sicurezza migliorata nel package Image Recognition
Ora è possibile godere di una maggiore sicurezza quando si usa una qualsiasi delle actions Image
Recognition dal package Image Recognition. La registrazione delle immagini è ora disabilitata per
garantire che se un bot fallisce durante l'esecuzione di una delle actions Image Recognition, le
immagini di origine e di destinazione acquisite non siano più memorizzate nella cartella dei log.

Miglioramenti al filtro oggetto nel package Email (ID caso Service Cloud: 00776374,
00953823, 975605)
Quando ti connetti a un server EWS (Exchange Web Services), per ripetere una serie di azioni su
tutti i messaggi e-mail che soddisfano una serie di criteri, usa l'action Sposta tutti dal package
Email oppure usa Esegui loop > Iteratore  > Per ogni e-mail nella casella di posta. Il campo
Quando l'oggetto contiene è ora sensibile alle maiuscole e alle minuscole. Quando inserisci un
testo all'interno di una coppia di doppie virgolette ("") nel campo Quando l'oggetto contiene, il
bot recupera tutti i messaggi e-mail il cui oggetto corrisponde esattamente al testo che hai inserito
all'interno della coppia di doppie virgolette.
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Cambio del nome della variabile predefinita
Il nome della variabile predefinita di tipo stringa è ora cambiato da prompt-assignment a
SampleString.

Nota:  Questa modifica si riflette solo sui nuovi bots.

Modifica delle informazioni sull'attività nella pagina Cronologia
Le informazioni sulle attività di esecuzione dei bot vengono conservate per 90 giorni nella pagina
Cronologia attività della Control Room. Le informazioni più vecchie di 90 giorni possono essere
visualizzate nei registri di audit.
Visualizza attività completate alla pagina 2614

Miglioramento del controllo modalità Registrazione sicura
Se sei un amministratore, ora puoi attivare o disattivare la modalità Registrazione sicura in base ai
ruoli utente assegnati (autorizzazioni) per un controllo più granulare della Control Room.
Registrazione sicura alla pagina 37

La tabella seguente elenca le correzioni e la build in cui ogni problema è stato risolto. Build 12350 è la
build più recente e include correzioni delle build precedenti.

Correzioni

Crea ID caso Service
Cloud

Descrizione

12350 01768021, 01803781 Dopo l'aggiornamento, la Control Room non si blocca
più e si comporta normalmente. In precedenza, la
Control Room non rispondeva dopo l'aggiornamento a
causa di blocchi Java.

12350 01802575,
01803323,
01803800,
01804121, 01804820

Dopo l'aggiornamento da una versione precedente
a questa versione, quando si eseguono i bots, i bots
migrati non mostrano più un errore per le variabili tra
virgolette doppie (" "). Non devi rimuovere le doppie
virgolette come soluzione per eseguire i bots.
Ad esempio, dopo l'aggiornamento da Automation
360 v.23, puoi eseguire un bot con il package
Excel advanced che contiene la seguente variabile:
"$HeaderCounter$"

12342 00827504,
00788652,
00827730, 01259452

Con le autorizzazioni richieste, è ora possibile
visualizzare le informazioni corrette nella pagina
Cronologia attività. In precedenza, un errore "Non
si dispone di autorizzazioni sufficienti" poteva impedire
anche agli utenti con autorizzazioni amministrative di
visualizzare alcune delle voci nella pagina Cronologia
attività.
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12342 00823799, 01623586 Quando si esegue la migrazione di MetaBots Enterprise
11 con i tipi di parametro variabile Input, Output e
Nessuno, questi sono ora correttamente mappati al
rispettivo tipo di parametro in Automation 360 dopo la
migrazione.
In precedenza, i tipi di variabile Enterprise 11 Input,
Output e Nessuno erano mappati al tipo Input/Output
dopo la migrazione.

12342 00819756 Dopo la migrazione, quando si esegue un bot che
contiene l'azione Passa al foglio e tale azione viene
eseguita, il foglio di lavoro è ora visibile e viene
attivato per ulteriori operazioni.

12342 01773270, 01781001 L'Utilità di migrazione cloud può ora connettersi
al database anche quando le credenziali del database
contengono i seguenti caratteri speciali:
& # @ % $

12342 00988580, 01200161 Dopo la migrazione da Enterprise 11 a Automation
360, è ora possibile eseguire Estrai bots e file
dipendenti nello spazio di lavoro Pubblico della
Control Room.
In precedenza, i file dipendenti non erano disponibili
per Estrai nello spazio di lavoro Pubblico della
Control Room. I bots padre dovevano prima essere
estratti in modo che i file dipendenti potessero essere
clonati automaticamente e resi disponibili per Estrai.

12342 00788046 Quando esegui un bot con Attendi, File, Cartella
come Azioni o Se/Esegui loop come Condizioni
e se le opzioni Data di inizio e Data di fine sono
impostate sullo stesso giorno, i bots ora eseguono le
rispettive azioni o condizioni in base alla data di fine
impostata.

12342 01598462 Il comando Esegui logica ora funziona correttamente
quando i MetaBots contengono una Logic con
parametri differenti assegnati a ciascuna Logic. Se si
disabilita una Logic in un MetaBot, l'altra Logic e il suo
comando funzioneranno correttamente.
In precedenza, se in un MetaBot una Logic veniva
disabilitata, anche i comandi relativi ad un'altra Logic
venivano disabilitati.
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12342 01251985,
01264753, 01272804

Nel pacchetto BAPI SAP, il comando Ottieni tabella
per il sottotipo Tabella recupera ora con successo
i risultati relativi ai parametri Importa, Esporta e
Tabella.
In precedenza, se si eseguiva il comando Ottieni
tabella per il sottotipo Tabella per i parametri
Importa o Esporta, il comando non andava a buon
fine.

12342 01262390 Quando si migrano bots Enterprise 11 che utilizzano la
condizione SE > Il file esiste con un carattere jolly
nel nome del file, l'esecuzione ora riesce correttamente
indipendentemente dalla disponibilità nel percorso
della cartella padre.
In precedenza, se la cartella padre non era presente
nel percorso della condizione, l'esecuzione del bot
veniva interrotta e si riscontrava un errore.
Se stai utilizzando questa versione o una versione
precedente, puoi usare SE > Il file esiste con la
cartella padre, insieme all'attuale condizione SE > Il
file esiste con il carattere jolly.

12342 -- Un bot migrato che include il comando File e cartella
ha la casella di controllo Includi le date di inizio
e fine abilitata per impostazione predefinita. Di
conseguenza, i bots Enterprise 11 non hanno più esito
negativo in Automation 360 quando viene eseguita
l'operazione di rinomina del file, anche se le date di
inizio e fine specificate sono le stesse per il confronto
con la condizione È tra.

12342 01751462 Quando il comando Run Task con un percorso variabile
è disattivato e la variabile usata nel percorso viene
eliminata, il comando TaskBot può ora essere migrato,
senza errori. In precedenza, la migrazione non riusciva
e veniva visualizzato un errore di pre-elaborazione.

12342 00824337 Il risultato della migrazione non mostra più un
messaggio di errore dopo la migrazione di un bot con il
nome credenziali in giapponese.

12342 00783883 L'action basata sulla tecnologia HTML (per esempio,
GetProperty) ora supporta il meccanismo di
ripetizione, che consente di migrare bots che includono
il comando registratore con un testo interno.

12342 -- Ora puoi migrare correttamente bots Enterprise 11
con valori negativi per le coordinate x e y dei campi
superiore e sinistro.

12342 00827997 Bot Scanner ora permette la migrazione di bots con
condizioni di espressione multiple che includono una
riga di codice disabilitata, senza mostrare più errori.
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12342 00834597 Bot Scanner ora analizza con successo una schermata
MetaBot e non mostra più un errore per la pre-
elaborazione del file di origine.

12342 01213241 Tutti i plug-in vengono ora caricati correttamente
quando si apre un foglio Excel usando l'action Excel >
Apri.

12342 01504682 Bot Scanner non mostra più un errore interno anche
se un bot contiene uno qualsiasi di questi caratteri
speciali: &#26.

12342 -- Ora puoi migrare con successo bots Enterprise 10 che
hanno ruoli con autorizzazioni cartella. In precedenza,
tali autorizzazioni non venivano migrate.

Nota:  Il ruolo Esegui e programma non viene
migrato.

12342 01632298 Ora puoi migrare con successo bots con variabile
Analisi tramite Bot Migration Wizard e dopo la
migrazione lo stato viene visualizzato come operazione
riuscita. In precedenza, questi bots rimanevano
bloccati allo stato In corso e quindi i bots non
venivano eseguiti.

12342 00828781,
01258567,
01273170, 01469879

I Bots ora completano la loro esecuzione più
velocemente di prima quando un proxy viene abilitato
attraverso un file PAC nelle distribuzioni Cloud.

12342 01385567, 01749465 La Control Room ora mostra le informazioni corrette
per Visualizza i siti intranet in Visualizzazione
compatibilità in Impostazioni di Visualizzazione
compatibilità. In Automation 360 v.23, veniva
visualizzata una pagina vuota a causa di un problema
interno.

12342 00807226, 01148097 Se un indirizzo di subnet IP contiene il numero 80
(per esempio, 192.30.80.25), ora puoi configurare
la porta della Control Room su 80 nel programma di
installazione.
In precedenza, se l'indirizzo di subnet conteneva
il numero 80, la porta della Control Room non
poteva essere configurata su 80. Era necessario
configurare per l'IP un numero di porta diverso che
non contenesse 80.

12342 00836549 Quando si copia un ruolo usando Crea ruolo
all'interno di una Control Room, l'utente e le
autorizzazioni bot vengono mantenute correttamente.
In precedenza, la modifica del ruolo associato causava
la perdita di tutte le autorizzazioni bot associate.
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12342 01434341,
01755003,
01755713,
01756244,
01757083,
01756871, 01758346

Ora puoi cercare i caratteri giapponesi all'interno
dei bot usando la casella di ricerca Trova in questo
bot. In precedenza, i caratteri giapponesi digitati
con la tastiera non venivano inseriti correttamente
e si doveva ricorrere a una soluzione alternativa per
cercarli.
Japanese language search support

12342 -- Se si Archivia un bot nello spazio di lavoro Pubblico
della Control Room, dopo aver filtrato i dati delle
dipendenze, quando il bot viene esportato, vengono
ora visualizzati solo i dati filtrati. In precedenza, anche
dopo aver filtrato i dati delle dipendenze, venivano
visualizzati tutti i dati.

12342 00819477 È ora possibile visualizzare i file dipendenti quando
si apre un bot nell'editor di bot. In precedenza, i
file dipendenti erano elencati solo in modalità di
visualizzazione.

12342 -- Quando il nome di un pool di dispositivi include
il carattere trattino basso (_), il programma di
installazione MSI ora completa la registrazione
automatica delle proprietà del pool di dispositivi,
con nomi di pool di dispositivi con trattini bassi da
popolare. In precedenza, il programma di installazione
MSI non completava la registrazione automatica di un
dispositivo se il pool di dispositivi includeva un trattino
basso.

12342 01758029,
017596611

Ora puoi utilizzare l'autenticazione AD Azure per la
connessione al server del database Azure durante
l'installazione della Control Room utilizzando il
programma di installazione Windows e lo script di
installazione. In precedenza, se l'autenticazione AD
Azure era selezionata nella finestra del server del
Database, l'installazione della Control Room non
riusciva.

12342 -- Dopo aver installato o aggiornato Automation 360
da una versione precedente, la pagina Riepilogo
dell'installazione della Control Room ora mostra il
numero di versione corretto. In precedenza, la pagina
mostrava un numero di versione non corretto.

12342 00796190,
00827493, 01251725

Quando si distribuisce un bot, la finestra di runtime ora
mostra il numero di riga e il nome del package corretti
per l'action Acquisisci screenshot del pacchetto
Error Handling. Puoi trovare il numero di riga esatto
che ha causato l'errore utilizzando una variabile
nell'opzione Gestore errori:Opzione Cattura >
Assegna numero di riga a.

© 2023 Automation Anywhere. All rights reserved.     283

https://apeople.automationanywhere.com/s/article/Japanese-word-is-not-able-to-search-via-Find-in-this-bot-in-A360-23


    Automation Anywhere - Learn

Correzioni

Crea ID caso Service
Cloud

Descrizione

12342 00800990 Ora è possibile rinominare un bot cambiando il testo
da maiuscolo a minuscolo o da caratteri a larghezza
ridotta a caratteri a larghezza intera. Per esempio, è
possibile rinominare un bot da Automatizzare ad
automatizzare.
In precedenza, il testo nel nome del bot non poteva
essere modificato. Quando il testo veniva modificato,
veniva visualizzato il messaggio di errore seguente:
Impossibile creare un file
denominato <filename>.Questo
nome è già utilizzato.Per
continuare, rinomina il file.Codice:
repository.exception.file.exists

12342 01258242 Quando esegui un bot che contiene più condizioni
e un operatore mancante in una delle condizioni
attraverso il Bot editor, viene ora visualizzato un
messaggio di errore relativo all'operatore mancante.
Quando aggiorni un'action e salvi le modifiche ma
manca un operatore, viene aggiunto un operatore E
per impostazione predefinita. In precedenza, i bots
con condizioni multiple avevano esito negativo a
intermittenza con errori del preprocessore.

12342 00805738 Ora viene visualizzato un messaggio di errore e non
è più possibile effettuare l'archiviazione o l'estrazione
dei file i cui percorsi sono identici tranne che per le
differenze di maiuscole/minuscole. In precedenza,
quando il percorso del file presentava maiuscole/
minuscole diverse e veniva archiviato o estratto, si
verificavano problemi durante la distribuzione del bot.

12342 01753711 Quando si effettua l'estrazione di una cartella che
contiene attività con dipendenze, non si verificano
più problemi. In precedenza, nelle operazioni di
confronto delle stringhe si verificavano problemi legati
a maiuscole/minuscole, con conseguenti errori nelle
operazioni di archiviazione ed estrazione.

12342 01271474, 01761856 Quando si assegna un'etichetta di produzione a un
bot figlio che ha più di una versione, la versione di
produzione viene ora visualizzata durante le operazioni
del bot. In precedenza, invece della versione di
produzione, veniva visualizzata la versione più
aggiornata del bot.

12342 01270601,
01260628,
01255632,
01758499,
01775489,01773778

Quando ti connetti con Microsoft Outlook, IMAP o
POP3, ora puoi creare un bot e salvare tutte le e-mail
in una cartella anche se l'oggetto dell'e-mail contiene
caratteri barra (/) o barra rovesciata (\). Quando
salvi le e-mail, i caratteri barra (/) e barra rovesciata
(\) nella riga dell'oggetto sono ora sostituiti da un
carattere di sottolineatura (_).
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12342 01755993,
01782945,
01775161, 01792954

In the Email package when you connect to Microsoft
Outlook to automate an email-related task, you can
now use the Move all action followed by Loop action
to move unread emails from one folder to another
folder. In precedenza, quando eseguivi il bot, il bot non
riusciva a spostare le e-mail non lette a causa di un
errore.

12342 01264563 Ora è possibile creare un bot usando l'opzione
Sessione globale  nell'action Apri del package
DLL e scegliere La Sessione DLL non esiste per
la condizione Se. In precedenza, veniva riscontrato
un errore quando l'action Apri del package DLL e
la condizione If (La sessione DLL non esiste)
venivano richiamate più volte in una sequenza.

12342 01258059 Nel package XML quando si crea un bot per recuperare
i dati utilizzando l'action Ottieni nodo singolo e il file
XML ha alcune righe commentate, l'output non mostra
più quelle righe. In precedenza, l'output mostrava le
righe che erano state commentate.

12342 -- In SOAP Web Service, quando si seleziona Parametro
dati non elaborati e si usa l'opzione Crea Xpath,
è ora possibile estrarre con successo i valori dalla
risposta SOAP e memorizzare l'output XML in una
variabile. In precedenza, non si potevano estrarre
valori dalla risposta SOAP perché l'opzione Crea
Xpath non funzionava come previsto.

12342 01071731, 01762875 Quando si apre un file CSV o TXT, si leggono dati da
quel file e si scrivono dati da una variabile tipo Table
nel file, il bot non ha più esito negativo se il file CSV
o TXT contiene grandi insiemi di dati. Il bot viene
ora eseguito con successo anche quando le caselle
di controllo Crea cartelle/file se non esistono
e Sovrascrivi file esistente sono selezionate
nell'action Scrivi su file.

12342 00968574 Non si verifica più un errore quando si crea un
bot usando l'action Apri del package VBScript e
si seleziona un file VBScript dal desktop con
l'estensione del file in maiuscolo. In precedenza, se
l'estensione del file era in maiuscolo, il bot falliva
perché il file era considerato un file di script non
valido.
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12342 00831463 Utilizzando il package Email, è ora possibile inviare
e-mail con l'oggetto delle stesse contenente una
combinazione di caratteri giapponesi a larghezza
ridotta e caratteri katakana. In precedenza, se
l'oggetto dell'e-mail conteneva una combinazione di
caratteri giapponesi a larghezza ridotta e caratteri
katakana, l'output visualizzato nella mail ricevuta era
confuso.

12342 00822222 Quando ti connetti al server EWS per automatizzare
un'attività relativa alle e-mail, ora puoi inviare più e-
mail senza fornire alcun valore nel campo oggetto
quando usi l'action Invia e-mail in un loop. In
precedenza, se nel campo oggetto il valore era vuoto,
il bot non riusciva a leggere tali e-mail.

12342 00823283 Nel package FTP / SFTP non si riscontra più alcun
errore quando si fornisce il nome della cartella come
punto (.) nell'action Ottieni le cartelle. Quando si
esegue il bot, questo scarica tutte le cartelle dalla
directory corrente al percorso della cartella locale
indicato nell'azione.

12342 00824379 Nel package Google Sheets, quando si apre un foglio
di calcolo e si usa Vai alla cella con un'opzione
cella come Cella specifica, il foglio di calcolo ha più
di 40.000 righe e si seleziona l'opzione Una cella
sottostante, il bot viene eseguito con successo.
In precedenza, si verificava un errore durante
l'esecuzione del bot.

12342 00788970 Il nome del bot viene ora tradotto correttamente
in cinese (cinese semplice) nella finestra Bot in
esecuzione. In precedenza, il nome del bot veniva
visualizzato come confuso nella finestra Bot in
esecuzione.

12342 01270344, 01767148 Quando si utilizza il package Google Sheets e si apre
un foglio di calcolo di Google, ora è possibile usare
l'action Ottieni nomi di tutti i fogli per recuperare
correttamente i nomi di tutti i fogli. In precedenza, se
il foglio di calcolo di Google aveva più di cinque fogli, il
bot riscontrava un errore.

12342 01709026,
01755897,
01768689,
01761434, 01554474

Non si verificano più errori quando si stabilisce una
connessione utilizzando il driver OBDC nel package
Database. Per Microsoft SQL Server, il valore vuoto è
ora inserito come 0 nella tabella del database per la
colonna int.
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12342 01602081 Quando si utilizzano actions dal package REST Web
Service per inviare richieste e ricevere risposte da
un'API REST e per memorizzare lo stato di risposta
dell'API in una variabile dizionario, REST ora restituisce
intestazioni e contenuto del corpo vuoto in risposta
anche se l'API non ha corpo di risposta.

12342 01758733 Quando effettui la migrazione da Enterprise 11 a
Automation 360, dopo aver modificato o aggiunto
actions a un bot che non esiste in un botpadre, il
salvataggio del bot ora avviene senza ritardi. In
precedenza, era necessario un po' di tempo per
salvare il bot.

12342 01254323 Non si verifica più un errore quando si usa l'action
Crea cartella di lavoro del package Excel advanced
per creare una cartella di lavoro all'interno di una
cartella in un percorso di unità di rete.

12342 01036851 Quando si apre un file con estensione .xlsx
utilizzando l'action Apri del package Excel advanced,
il bot non fallisce più anche se una cartella padre
intermedia non ha privilegi di accesso. Per esempio,
l'action Apri può aprire il file da \\share\a\b\c
\file.xlsx se la cartella \\share\a\b\c ha
privilegi di accesso anche se le cartelle \\share\a o
\\share\a\b non dispongono di privilegi di accesso.

12342 00827204 Sui computer che utilizzano le versioni giapponese
e cinese dei sistemi operativi, non si verifica più
un errore quando si cerca di riportare una scheda
alla prima pagina web aperta utilizzando l'action
Torna indietro del package Browser deselezionando
l'opzione Genera un errore se il numero di
passaggi è superiore a quello della cronologia.

12342 00777283, 00829912 Quando si usa l'action Apri del package Excel
advanced per aprire un foglio di lavoro di Microsoft
Excel, utilizza l'action Sostituisci del package Excel
advancedper sostituire una stringa nel foglio di lavoro
e poi eseguire il bot, il bot ora funziona come previsto
e non si blocca anche se la stringa da sostituire non è
presente nel foglio di lavoro Excel.

12342 00835312 Non si verifica più un errore quando si crea un
collegamento a una cartella usando l'action Apri
programma/file del package Application per aprire
un file e utilizzando poi l'action Crea collegamento
del package Folder.

12342 00757943,
00787404,
00788421,
00807528,
00822941, 01018972

Ora puoi utilizzare l'action AI Sense in un bot padre e
l'action OCR in un bot figlio oppure utilizzare entrambe
le actions contemporaneamente per eseguire il bot.
In precedenza, ciò causava un errore 12 ABBYY
FineReader Engine.
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12342 01212753, 01470071 Quando la sessione corrente di un'applicazione su
Citrix viene chiusa e l'applicazione viene riavviata,
il Recorder ora identifica l'oggetto ed esegue con
successo l'action corretta. In precedenza, il Recorder
non riusciva a identificare l'oggetto.

12342 00742936, 00808117 Ora puoi convertire un valore data e ora specificando
formati data e ora personalizzati (per esempio
hh:mm:ss). In precedenza, si verificava un errore
quando si usava la convenzione hh per specificare un
formato data e ora personalizzato.

12342 01266752 Quando utilizzi la versione 6.2.0-20210903-141520 del
package Excel advanced per eseguire una macro su
un foglio di lavoro di Microsoft Excel, i valori nelle celle
di riferimento del foglio di lavoro Excel vengono ora
aggiornati correttamente.

12342 01755439 Non si verifica più un errore quando si usa la versione
2.5.3-20220304-010651 del package Recorder per
acquisire un oggetto. In precedenza, quando utilizzavi
la versione 2.4.0-20211118-080716 del package
Recorder, il bot non andava a buon fine restituendo
il seguente messaggio di errore: Il bot non può
essere eseguito a causa di un errore
nell'impostazione dell'ambiente di
esecuzione

12342 01276429 Dopo la migrazione, puoi richiamare un bot
riutilizzabile con la nuova versione del package dallo
stesso bot padre con cui condivideva una sessione.
Per farlo, inserisci una variabile di sessione inizializzata
con un valore a una chiave del dizionario con l'action
Dizionario >  Metti.

12342 00805417,
00815023, 01049408

Ora puoi usare Recorder per eseguire con successo
la pressione di tasti e acquisire oggetti su una nuova
scheda aperta nel browser Google Chrome.

12342 -- Nell'action Browser > Apri, quando si seleziona
la preimpostazione Ultima scheda del browser
utilizzata per la finestra Internet Explorer
nell'opzione Scheda esistente, la scheda e la finestra
corrispondenti vengono ora attivate.

12342 01755590 In RPA Workspace, quando passi a Automazione >
Bot Store ed effettui l'accesso, ora puoi accedere a
Bot Store senza problemi.

12342 -- Quando si aggiunge o si rimuove un ruolo di
consumatore dall'armadietto, i valori dei ruoli non
vengono più cambiati quando si ordina la tabella. In
precedenza, i valori nelle colonne Modifica di e Ultima
modifica venivano modificati inavvertitamente.
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12342 01272058, 01752731 Ora puoi mettere in pausa o interrompere le tue
automazioni del carico di lavoro in corso e non
viene più visualizzato alcun Errore interno del
server.
In precedenza, l'automazione del carico di lavoro non
poteva essere messa in pausa o interrotta dopo che
l'utente che aveva creato l'automazione era stato
eliminato dalla Control Room.

12342 01181402, 01260706 Mentre si eseguono le automazioni del carico di lavoro,
non è più necessario mettere in pausa e poi riprendere
per eseguire i bots in coda bloccati nello stato In
corso.

12342 00790086 La traduzione giapponese per la descrizione del
programma dei campi di frequenza giornaliera e
mensile per l'opzione Esegui ripetutamente
(Gestisci >  Programmi > Programma un bot) è
ora corretta. La descrizione giapponese corretta è ora
disponibile nella pagina Programma un bot.

12342 00852637 Quando si modifica il programma di un bot nella
Control Room, la colonna dei programmi nella
pagina Programmati ora mostra la data corretta
del programma invece del giorno precedente. In
precedenza, per esempio, se un bot era programmato
per 01-ott-2021, la pagina Programmati mostrava
erroneamente la data di pianificazione come 30-
set-2021.

12342 00821057, 01188160 Se un file viene esportato dopo che il nome del bot
e il percorso della cartella sono stati modificati, il bot
ora riflette il nuovo nome. In precedenza, il bot veniva
esportato con il vecchio nome.

12342 01252294 Ora puoi importare correttamente i file zip nel formato
Zip64 dall'ambiente di sviluppo all'ambiente di
produzione.

12342 -- Ora puoi eseguire più code senza alcun ritardo tra una
coda e l'altra. In precedenza, quando si eseguivano più
code, a volte si verificava un ritardo da 5 a 15 minuti
tra le code.

12342 00800831,
00815411,
00826054, 00826058

Quando usi l'opzione Esporta gli elementi
selezionati in CSV, i dati della programmazione
in un file .csv vengono ora salvati correttamente.
In precedenza, quando si esportavano i dati del
programma in un file csv della pagina Attività
programmata della Control Room, i dati del file
venivano salvati in modo errato. Per esempio, il tipo di
programma veniva salvato come Ripetuto nel file csv
invece di Una volta.
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12342 01754721,
01753460,
01767806 01759361,
01763327,
01764201,
01767827, 1770574

Se l'impostazione di localizzazione di sistema viene
modificata, i bots programmati settimanalmente ora
vengono eseguiti come programmati dalla Control
Room. In precedenza, quando l'impostazione del
locale di sistema veniva cambiata, i bots non venivano
eseguiti secondo il programma.

12342 00714546,
00759029, 01257992

La Control Room può ora integrare un archivio Git che
rifiuta il force push. In precedenza, alcuni protocolli
di sicurezza rifiutavano tutti gli aggiornamenti force
push rendendo l'integrazione git incompatibile senza
una configurazione per il contrassegno force push. Ora
puoi modificare la configurazione del Git push dalla
Control Room per disabilitare il contrassegno force
push.

La seguente tabella elenca le limitazioni identificate nella versione attuale:

Limitazioni

(ID caso Service Cloud: 01765712) If a MetaBot Logic was using a DLL file that used classes
without namespaces, after migration, any TaskBot that uses the MetaBot Logic does not work.
Soluzione: Manually update the DLL file to include namespaces for classes.

Se hai creato la mappatura del ruolo Active Directory nelle versioni precedenti, quando esegui
l'aggiornamento a Automation 360 v.24, alcune mappature di gruppo definite in precedenza
vengono eliminate perché la colonna Distinguished Name (DN) delle voci di mappatura nel database
contiene righe vuote, senza valori. Prima di eseguire l'aggiornamento a Automation 360 v.24, esegui
uno script per popolare la colonna DN. (ID caso Service Cloud: 00751756)
Per assistenza su questo problema, contatta il team di assistenza: Open a support case (A-People login
required)

L'utilità di premigrazione Bot Insight riscontra un errore e si chiude quando rileva ID dashboard
corrotti nelle tabelle BI. (ID caso Service Cloud: 00796546)
Soluzione: Scarica e installa l'utilità di premigrazione Bot Insight più recente dal sito di supporto di
Automation Anywhere.

Quando crei i bots utilizzando le actions di trascinamento dalla tavolozza Azioni, il flusso di lavoro
dei bot si sposta sul lato destro nella vista Flusso.
Soluzione:
• Quando crei o modifichi un bot nell'Bot editor, aggiungi nuove actions dalla tavolozza Azioni

facendo doppio clic sull'action che desideri utilizzare.
Ad esempio, se stai modificando un bot e vuoi aggiungere una nuova action dopo la riga 7,
posiziona il punto di inserimento dopo la riga 7, quindi, dalla tavolozza Azioni, fai doppio clic
sull'action che desideri utilizzare.

• Se desideri utilizzare l'opzione di trascinamento, assicurati di trascinare le actions un po' più
velocemente nell'area di disegno.
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(ID caso Service Cloud: 01798098) Quando aggiorni Automation 360 da una versione precedente
a questa versione su un computer Windows, potrebbe essere visualizzato il seguente messaggio di
errore relativo a una firma digitale non valida:
Errore 1330: A file that is required cannot be installed because the
 cabinet file
        E:\AA\....\Data1.cab has an invalid digital signature.

Soluzione: A360.24 Installation Failure "Error 1330 Invalid Digital Signature" (A-People login required)

Se l'opzione Aggiorna automaticamente tutti gli agenti bot è selezionata ed effettui
l'aggiornamento a questa versione, l'aggiornamento automatico alla versione più recente di alcuni
Bot Agent potrebbe avere esito negativo.
Soluzione:
1. Disinstalla manualmente la versione esistente di Bot Agent.
2. Installa la versione più recente di Bot Agent.

Quando esegui la migrazione dei bots Enterprise 11 con il comando Comment abilitato, il comando
viene disabilitato dopo la migrazione. (ID caso Service Cloud 01255723, 01252824, 01260677,
01608653)

Quando accedi come amministratore dopo la migrazione e avvii una migrazione di bot, nel pannello
Registri di audit viene visualizzato a intermittenza un messaggio di operazione non riuscita con
errore Arresto anomalo di Bot Launcher.

Quando si migrano bots con variabili di sistema (come data, mese o anno) come opzione Esporta
dati in CSV, viene visualizzato un errore di pre-elaborazione. (ID caso Service Cloud: 01755175)

Quando aggiorni la Control Room da Automation 360 v.21 o v.22 a Automation 360 v.23 o v.24,
l'installazione potrebbe avere esito negativo a causa di problemi di migrazione del programma. (ID
caso Service Cloud: 01376353, 01449535, 01713118, 01627144, 01762404)
Soluzione: Open a support case (A-People login required).

Gli amministratori possono esportare i dati, fino a 100.000 voci, in un file CSV. I file audit .csv
scaricati vengono memorizzati temporaneamente nella cartella C:\Windows\TEMP\ nell'ambiente
On-Premises. I file in questa cartella con nome che inizia con cr-audit non devono essere
eliminati per almeno 90 giorni e possono essere scaricati dalla Control Room.
Vedi .Export audit data to CSV alla pagina 2681

Quando si aggiorna automaticamente Bot Agent contemporaneamente su 500-1.000 dispositivi
nella Control Room (On-Premises), l'aggiornamento automatico fallisce.
Soluzione: Aggiornare manualmente Bot Agent su pochi dispositivi alla volta dalla pagina
Dispositivi della Control Room.

Nei browser come Microsoft Edge (Chromium) e Mozilla Firefox, quando viene scaricato il file del
programma di installazione dell'Bot Agent, le informazioni sul download sono riportate nell'angolo
in alto a destra, anche se la freccia del download punta all'angolo in basso a sinistra della barra dei
comandi del browser.
La freccia di download indica la direzione corretta solo per il browser Google Chrome, in cui le
informazioni sul download sono riportate nell'angolo in basso a sinistra della barra dei comandi del
browser.
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Per una Control Room installata su un sistema operativo Linux, il file
AutomationAnywhereBotAgent.msi non è disponibile per il download con l'opzione
Scarica programma di installazione dalla pagina Control room > Amministrazione >
Impostazioni.
Soluzione: Per installare l'Bot Agent, utilizza il file AutomationAnywhereBotAgent.msi dalla
cartella <application filepath>\crui\asset di una Control Room (On-Premises) installata
su un sistema operativo Windows. Per ulteriori informazioni, consulta Sample steps to create Bot Agent
golden image (A-People login required).

Nel package Email, quando si utilizza l'opzione Progettazione HTML per creare e personalizzare
il layout e il corpo dell'e-mail e incollare poi il contenuto copiato da un'altra fonte, come Outlook o
Notepad++, lo stile, la dimensione e il colore del carattere non vengono attualmente mantenuti per
le actions seguenti:
• Invia
• Rispondi
• Inoltra

Quando crei un bot utilizzando actions come Invia, Rispondi o Inoltra dal package Email, scegli
un'opzione tra Testo semplice, Progettazione HTML o Codice HTML per formattare il corpo
dell'e-mail. Quando si passa da una all'altra delle schede (Testo semplice, Progettazione
HTML o Codice HTML), il valore precedentemente impostato nel corpo del messaggio non viene
mantenuto per cui rimane vuoto.

• Gli iFrame nidificati non sono supportati nei browser Google Chrome e Microsoft Edge
Chromium.

• Il supporto per acquisire i pop-up di autenticazione delle finestre non è disponibile quando si
automatizza il browser Google Chrome.

• Dopo aver eseguito un'action in un'applicazione o in una pagina, se durante l'esecuzione viene
aggiunto un frame all'applicazione o alla pagina oppure se compaiono finestre pop-up, finestre di
dialogo di avviso, conferma o richiesta su tale frame, le suddette finestre non vengono acquisite.
Soluzione: Utilizza le actions nel package Riconoscimento delle immagini o l'action Mouse >
Fai clic invece di eseguire il bot.

Sui computer in cui il SystemLocale è impostato su una lingua diversa dall'inglese, quando apri più
schede in un browser, provi a eseguire qualsiasi action su una nuova scheda attualmente inattiva ed
esegui il bot, la nuova scheda inattiva non verrà attivata.

In Internet Explorer, per attivare una tra più pagine web senza titolo, vengono confrontati solo
i nomi di dominio completamente qualificati (FQDN). Se pagine che non hanno titoli, ma con lo
stesso FQDN vengono aperte in Internet Explorer, ogni scheda corrispondente a FQDN viene
attivata.

In Internet Explorer, quando si usa l'action Chiudi per chiudere una scheda o una finestra, questa
viene chiusa solo se non è presente una finestra di dialogo di avviso.

Nota:  La scheda o la finestra Internet Explorer con una finestra di dialogo di avviso viene chiusa
solo quando si chiude manualmente la finestra di dialogo di avviso.

© 2023 Automation Anywhere. All rights reserved.     292

https://apeople.automationanywhere.com/s/article/A360-Sample-steps-to-create-Bot-Agent-golden-image
https://apeople.automationanywhere.com/s/article/A360-Sample-steps-to-create-Bot-Agent-golden-image


    Automation Anywhere - Learn

Limitazioni

Quando si usa l'action Apri del package Excel advanced per aprire file con estensione .xlsm che
contengono grafici, il bot fallisce con un errore.
Soluzione: Indicare il nome del foglio Excel nel campo Nome foglio specifico ed eseguire il bot.
Se ci sono fogli nascosti, scopri il foglio specifico e rendilo attivo.

Quando automatizzi applicazioni Web in esecuzione su Microsoft Edge Chromium con modalità IE
o Internet Explorer, il Recorder a volte non riesce ad acquisire l'oggetto dalla scheda del browser
selezionata e lo acquisisce dall'ultima scheda utilizzata.
Soluzione: aggiorna l'Bot editor e avvia nuovamente la registrazione.

When you use the Recorder to capture an object, select HTML Tag, HTML InnerText, and HTML
type properties in Search Criteria, or migrate a bot with similar properties selected in Search
Criteria, the bot might fail to identify or locate the object and perform the selected action.
Soluzione: modifica il DomXpath in base ai controlli che acquisisci o aggiungi altre proprietà in
Criteri di ricerca.

When you use the Datetime package released with Automation 360 v.23 or earlier to create a bot
that uses the Datetime Assign action, then select the variable option to add the variable value
and try to run the bot with package released with Automation 360 v.24 or later, the UI shows a
compilation error, and the user must select the variable value again.

In the Recorder package, the Run in background option that enables an automation to run in
the background is not supported for applications running on Google Chrome, Microsoft Edge, and
Mozilla Firefox browsers for any of the Recorder actions.

La seguente tabella elenca le limitazioni delle versioni precedenti applicabili anche a questa versione:

Limitazioni rispetto alle versioni precedenti

Quando si esegue la migrazione a un bot utilizzando l'action Manage Window Controls, l'ultima
cifra del valore dell'altezza non è disponibile dopo la migrazione. Tuttavia, il bot verrà eseguito
correttamente. (ID caso Service Cloud: 01756996)

Quando una sessione di Excel è attiva in SAP, si avvia un processo Excel corrispondente in
background. In questo scenario, Automation 360 utilizza lo stesso processo Excel iniziato da SAP.
Quando si esegue un bot per automatizzare i dati del foglio di calcolo, Automation 360 elabora la
prima richiesta con successo. Tuttavia, durante l'esecuzione, se l'Excel viene chiuso e viene inviata
una successiva richiesta di automatizzazione dei dati del foglio di calcolo, Automation 360 non
elabora la richiesta perché il processo Excel è ancora in fase di accesso da parte di SAP. Pertanto,
non viene attivata la finestra corretta per automatizzare i dati del foglio di calcolo. (ID caso Service
Cloud: 00815159)

© 2023 Automation Anywhere. All rights reserved.     293



    Automation Anywhere - Learn

Limitazioni rispetto alle versioni precedenti

Se si aggiorna direttamente da Automation 360 On-Premises v.21 a questa versione, si potrebbero
verificare problemi nell'aggiornamento del Bot Agent su alcune macchine Bot Runner nei seguenti
scenari:
• Dopo un aggiornamento del Control Room, lo stato del dispositivo continua a cambiare e il Bot

Agent non riesce ad aggiornarsi automaticamente.
• Se il file embedded resources è mancante, il Recorder non riconosce gli elementi

dell'interfaccia utente o non cattura un singolo oggetto nel browser Google Chrome.

Soluzione: prima di aggiornare a questa versione, rimuovere i seguenti file e cartelle Bot Agent:
• C:\Windows\System32\config\systemprofile\AppData\Local

\AutomationAnywhere\AA-DB.mv.db
• C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-resources

Per ulteriori informazioni, vedi Bot agent auto update fails post the Control Room Upgrade with
'device.connection.lost' (A-People login required) | The recorder is not able to recognize the GUI elements in
Google Chrome browser (A-People login required)

Quando utilizzi il comando Terminal Emulator con l'azione Invia testo che contiene la chiave LF
(Invio), il comando potrebbe avere esito negativo se la chiave LF non è supportata dall'Terminal
Emulator.
Soluzione: assicurati di sostituire la chiave LF con caratteri supportati come lo spazio.

Dopo la migrazione, un utente può eliminare un file .atmx anche se è associato a un programma
da Automation 360 Control Room.

Se si configura un archivio chiave esterno in Integrazione dell'archivio chiave esterno e si
seleziona la modalità Autenticazione SQL per l'autenticazione del database nella pagina del
programma di installazione di Windows Server di database per installare la Control Room (On-
Premises), l'installazione fallisce e viene mostrato il seguente messaggio di errore: Impossibile
creare le tabelle del database della Control Room.
Soluzione: aggiungi le credenziali del database nell'archivio chiave esterno e utilizza queste
credenziali per la configurazione del database.

Gli utenti della Control Room appena creati su Windows per VM On-Premises Google Cloud Platform
non possono modificare la propria password. L'opzione delle domande di sicurezza non è disponibile
nella schermata Cambia password e, di conseguenza, la Control Room visualizza un errore
quando si tenta di salvare la password.
Soluzione: aggiornare la pagina e modifica nuovamente la password.

(ID caso Service Cloud: 01768545) Stato dell'aggiornamento bloccato su IN_CORSO durante
la migrazione da Enterprise 11 a Automation 360
Quando esegui la migrazione da Enterprise 11 a Automation 360, anche se la migrazione del bot
ha esito positivo, Bot Insight non aggiorna lo stato nella Control Room. Fino alla versione 11.3.2,
il contrassegno analitico era abilitato per impostazione predefinita, quindi tutti i bots creati sono
identificati come bots analitici. Alcuni bots identificati come analitici non hanno dati elaborati
disponibili per il dashboard di Bot Insight. Di conseguenza, lo stato della migrazione si blocca su
IN_CORSO anche se la migrazione del bot ha esito positivo.

Quando tenti di automatizzare qualsiasi processo in un'applicazione Java che utilizza la versione
11.0.8 di AdoptOpenJDK, il Recorder a volte non acquisisce gli elementi a discesa nell'applicazione.
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Automation Anywhere Robotic Interface (AARI)

Novità

Microsoft Edge Chromium e Safari supportati per AARI
Ora è possibile creare moduli e processi in RPA Workspace ed eseguire richieste, attività e bots
nell'interfaccia web su Microsoft Edge Chromium e Safari.
Requisiti del browser per RPA Workspace alla pagina 866

Creazione di campi con password e occultamento di informazioni sensibili (ID caso
Service Cloud: 00714159, 01063512)
In RPA Workspace, è ora possibile creare campi password utilizzando l'elemento Password nel
proprio generatore di moduli. È possibile utilizzare l'elemento Password nell'interfaccia web per
aggiungere del testo mascherato ai campi password nei moduli iniziali per nascondere informazioni
sensibili.
Configura i processi alla pagina 2121 | Proprietà dell'elemento password alla pagina 2155

Configurazione di un utente pianificatore per ogni team
Ora è possibile accedere alla pagina Processo nell'interfaccia web per modificare un processo
e assegnare un utente pianificatore a ogni team. Questo assicura che i bots nel processo siano
distribuiti sui dispositivi assegnati a un team e che questi dispositivi non siano utilizzati da un altro
team. Per impostazione predefinita, l'utente pianificatore è Team, ma se l'utente pianificatore non
è definito, allora verrà selezionato l'utente pianificatore Processo. L'utente pianificatore Globale
sarà selezionato solo se gli utenti pianificatori Team o Processo non sono selezionati.
Assegnazione dell'utente del pianificatore al processo nell'interfaccia web alla pagina 2118

Configurazione del tipo di distribuzione del pianificatore (ID caso Service Cloud: 00814885,
01276257)
È ora possibile configurare il tipo di distribuzione del pianificatore per attività di bot nella
configurazione del processo e determinare il modo in cui i bots nel processo saranno distribuiti. È
possibile definire la mappatura tra l'utente Esegui come e il dispositivo che aiuta a prendersi cura
dei vincoli, come quelli sulle credenziali che richiedono una mappatura uno-a-uno tra l'utente Esegui
come e il dispositivo.
Configurazione del tipo di distribuzione per i bots alla pagina 2120

Miglioramento dell'ID di riferimento alle richieste
Ora è possibile visualizzare l'ID di riferimento associato al processo nella colonna Riferimento della
pagina Richieste. L'ID di riferimento è una combinazione di un prefisso e un numero creata da una
Chiave di processo che è possibile inserire quando il processo viene modificato per la prima volta.
Questo ID di riferimento viene incrementato ogni volta che viene creata una richiesta dal processo
corrispondente.
Proprietà dell'ID di riferimento alla pagina 2159 | Configure an AARI process alla pagina 2175

Impostazioni di conservazione delle richieste
Quando si modifica un processo, si ha ora la possibilità di impostare quando le richieste completate
verranno spostate dalla pagina Richieste al Cestino. Con questa funzione, si può evitare di
spostare manualmente le singole richieste completate nel Cestino. Si può scegliere di disabilitare
le impostazioni per spostare le richieste completate nel Cestino. È anche possibile impostare il
numero di giorni dopo i quali le richieste saranno eliminate dal Cestino.
Configure an AARI process alla pagina 2175
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Novità

Team predefinito assegnato al processo
È ora possibile modificare un processo per visualizzare il team predefinito a cui il processo è
assegnato nel campo Team predefinito. Il primo team a cui viene assegnato un processo viene
automaticamente impostato come team predefinito. Con questa funzionalità, è possibile visualizzare
il team predefinito a cui è assegnato un processo senza visualizzare ogni singolo team.
Configure an AARI process alla pagina 2175

Visualizzazione dello stato dei bot in coda
Ora è possibile visualizzare lo stato dei bots in coda e che non sono attivamente in esecuzione. La
pagina di visualizzazione della richiesta mostra ora l'etichetta In coda accanto ai bots in coda non
attivi.

Stato Annullata per le attività
È ora possibile filtrare le attività in base allo stato Annullata nella pagina Attività. Questo stato
mostrerà l'etichetta Annullata accanto ai risultati filtrati per informarti delle attività che sono state
annullate da un utente. Puoi filtrare questo stato dal menu a discesa nella barra di stato.
Filtrare e cercare un'attività alla pagina 2170

Riempimento degli elementi iniziali del modulo tramite parametri URL
Quando si crea una richiesta, è ora possibile riempire gli elementi iniziali del modulo creando script
di query che inseriscono parametri specifici nell'URL iniziale del modulo. Questi parametri sono
applicabili solo per gli elementi Data, Numero, Casella di testo e Ora.
Parametri URL alla pagina 2153

Miglioramento del servizio di archiviazione (ID caso Service Cloud: 00768394)
Come amministratore del tenant, è ora possibile impostare un'opzione di
configurazione per bloccare il caricamento di file eseguibili per prevenire una
violazione della sicurezza. È possibile bloccare il caricamento di file con le estensioni
seguenti: .acm, .ax, .cpl, .dll, .drv, .efi, .exe, .mui, .ocx, .scr, .sys e .tsp.

Esecuzione in finestra virtuale in configurazione bot
Se sei un amministratore AARI, puoi configurare bots nella pagina Bot e abilitare l'opzione Esegui
il bot in una finestra virtuale. Con questa opzione, un utente assistito in AARI Assistant può
eseguire bots in una finestra virtuale senza perdere la propria esperienza utente.
Configure an AARI bot alla pagina 2174

Aggiunta di regole all'elemento Pulsante
È ora possibile aggiungere regole all'elemento Pulsante.
Utilizzo dell'elemento Pulsante alla pagina 2190
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Novità

Personalizzazione del testo nei moduli usando gli aggiornamenti dell'elemento
Etichetta
Ora è possibile personalizzare il testo nei tuoi moduli in vari modi, come applicare il grassetto, il
corsivo, il sottolineato e altri effetti di formattazione, cambiare la dimensione e il colore del carattere
e così via, usando l'elemento Etichetta. Con queste opzioni, è possibile evidenziare messaggi o
testi specifici, come passi successivi, avvertimenti o errori, quando rappresentati nel modulo iniziale
nell'interfaccia web.
L'elemento Etichetta offre ora le opzioni di formattazione seguenti:
• Enfasi
• Colore carattere
• Dimensioni carattere
• Allineamento del testo

Utilizzo dell'elemento Etichetta alla pagina 2196

Ricerca e filtro di colonne in una tabella
Nella schermata del generatore del modulo, se si seleziona la casella di controllo Abilita il
filtraggio delle colonne per l'elemento Tabella, gli utenti possono cercare e filtrare il contenuto
per tutte le colonne disponibili quando il bot è in esecuzione.
Quando si usa l'elemento Tabella per riportare una tabella nei moduli iniziali, si dispone ora della
capacità migliorata di eseguire la ricerca su ogni colonna della tabella per valore.
Utilizzo dell'elemento Tabella alla pagina 2200

Opzioni aggiuntive per le regole
Con le opzioni aggiuntive incluse per le regole nel generatore di moduli, è ora possibile eseguire le
operazioni seguenti:
• Trovare una regola, ma usando la barra di ricerca. Nella barra di ricerca, inserisci il nome della

regola o l'etichetta dell'elemento associato a una qualsiasi condizione o action nella regola.
• Creare una copia di una regola usando l'opzione Duplica regola.
• Per le regole multiple, è possibile usare le opzioni seguenti per riorganizzare l'ordine in cui

queste regole vengono eseguite al momento dell'esecuzione del bot:
• Sposta su
• Sposta giù
• Sposta in alto
• Sposta in basso

Aggiunta di regole agli elementi di un modulo alla pagina 2202

Applicazione di un'action a più elementi
Se stai aggiungendo o modificando una regola, quando si aggiunge un'action, è ora possibile
applicare un'action a più di un elemento selezionando più elementi nel menu Quindi.
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Novità

Condizioni Se aggiuntive per alcuni elementi
Quando si crea o si modifica una regola, è ora possibile selezionare ulteriori condizioni Se per gli
elementi seguenti:
• Elenco a discesa
• Checkbox
• Pulsante di opzione
• Data
• Ora
• Collegamento ipertestuale

Utilizzo di Assegna per aggiornare il valore dell'elemento Elenco a discesa
Quando si aggiunge una regola, se si seleziona l'elemento Elenco a discesa come elemento di
un'action dal menu Quindi, è ora possibile utilizzare il menu a discesa Assegna per aggiungere o
sovrascrivere valori quando il bot è in esecuzione.
Aggiunta di regole agli elementi di un modulo alla pagina 2202

Gli elementi della condizione Se sono disponibili nell'azione Quindi
Tutti gli elementi utilizzati come parte della condizione Se sono ora disponibili come parte
dell'azione Quindi.

Righe multiple supportate per Area testo e Rich Text Editor
Il testo su più righe è ora supportato per gli elementi Area testo e Rich Text Editor all'interno
delle opzioni Se e Quindi.
Aggiunta di regole agli elementi di un modulo alla pagina 2202

Cosa è cambiato

Miglioramenti al processo di importazione in una cartella pubblica
Quando importi il tuo processo in una cartella pubblica, il processo viene ora pubblicato
automaticamente in AARI. In precedenza, era necessario archiviare i processi importati nell'archivio
privato e quindi ripetere nuovamente l'archiviazione del processo per pubblicarlo in AARI.
Importazione di un processo AARI alla pagina 2150 | Dipendenze del processo di importazione alla pagina
2150

Aggiornato il layout della pagina del processo
Il layout della pagina Processo è stato aggiornato per essere coerente con le pagine Bot e Team.
Le modifiche includono colonne per ID di riferimento, chiave, nome, descrizione, tag e team.
Ora puoi filtrare i tuoi risultati nella barra di ricerca per un ordinamento più veloce e un rapido
riferimento all'utente pianificatore globale corrente nella pagina.

Stato dei bot attivi
Nella pagina di visualizzazione delle richieste, ora puoi visualizzare lo stato esatto dei tuoi bot
facendo riferimento all'etichetta In corso accanto ai tuoi bots attivi attualmente in esecuzione. In
precedenza, l'etichetta In corso mostrava sia i bots attivi sia i bots in coda non in esecuzione.
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Cosa è cambiato

Riferimento per sostituire l'ID richiesta in AARI on the web
• Ora puoi filtrare o eseguire query per le tue richieste nelle schede Richieste e Cestino e

per le attività nella scheda Attività (Vista tabella e Vista dettagli) utilizzando il nuovo
Riferimento al posto di ID richiesta.

• L'URL Richieste, Team, Processoe Bot è ora cambiato in entity/ref/:ref
da entity/:id. Se apri una richiesta utilizzando ID richiesta, ora l'URL esegue il
reindirizzamento utilizzando Riferimento. Per esempio, supponiamo che l'ID richiesta sia 896
e il Riferimento sia 2-34 per una richiesta. Se visualizzi la richiesta tramite ID richiesta (/
aari/#/requests/all#/requests/896), l'URL esegue il reindirizzamento utilizzando il
Riferimento (/aari/#/requests/all#/requests/ref/2-34).

Il riferimento è una chiave univoca che ti consente di identificare richieste e processi correlati nelle
pagine Richieste, Team, Processo e Bot. Il riferimento è più facile da usare, oltre a essere
più significativo dell'ID richiesta, in quanto fornisce una sequenza logica di numeri di riferimento
incrementati per tenant. Il riferimento è univoco all'interno di un tenant, ma può essere lo stesso
per due tenant diversi.
Proprietà dell'ID di riferimento alla pagina 2159

La tabella seguente elenca le correzioni e la build in cui ogni problema è stato risolto. Build 12350 è la
build più recente e include correzioni delle build precedenti.

Correzioni

Crea ID caso Service
Cloud

Descrizione

12350 01788376 You can now launch AARI using the Bot Agent (version
21.133) connection without errors.

12350 01803979 Se hai una Control Room configurata con SAML e
fai clic sull'icona AARI sul Desktop Windows, viene
reindirizzato alla pagina web AARI Assistant della
home page Control Room.

12342 01759135 Quando utilizzi l'elemento Data e selezioni l'opzione
Usa la data del sistema locale quando questo
modulo viene caricato, ora la data viene
visualizzata correttamente con quella del sistema
locale.

12342 01766579 Se sei un Bot Creator, dopo aver creato una richiesta
tramite un processo AARI, ora puoi inviare il modulo
iniziale e completare le attività senza restare bloccato
nella pagina di visualizzazione della richiesta.

12342 -- Per RPA Workspace con impostazione SDS, quando
si inseriscono dati o si caricano file nei moduli iniziali
dopo aver selezionato un processo per eseguire la
richiesta, non si riscontra più un messaggio di errore di
eccezione.
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Correzioni

Crea ID caso Service
Cloud

Descrizione

12342 -- Quando si usa l'elemento Checkbox per creare un
Gruppo Checkbox nel modulo e si impostano le
regole del modulo e le condizioni per ogni casella in
questo gruppo (C1, C2, C3, e così via), le selezioni
funzionano ora correttamente nel modulo iniziale come
definito dalle regole del modulo.

12342 -- Se sei un Bot Creator e un gestore AARI, non si
riscontra più un errore quando si esegue un bot
utilizzando l'azione Membri del team dal pacchetto
AARI Web per accedere ai team.

12342 -- Se sei membro di un team per ruolo (cioè, se sei stato
aggiunto per la prima volta a un ruolo nella Control
Room e il ruolo è stato poi sincronizzato con un
team), sarai ora in grado di visualizzare le informazioni
aggiornate relative alle tue richieste e attività. La
pagina aggiorna ora automaticamente la richiesta più
recente e i dettagli dell'attività.

12342 -- Nell'interfaccia web, quando le attività sono
completate nella vista della richiesta e si dà conferma
cliccando su Termina, Annulla o qualsiasi altra
opzione primaria o secondaria, questi tipi di eventi
vengono ora acquisiti nella cronologia Log di audit in
RPA Workspace come un tipo di evento Attività umana
AARI.

12342 -- In ambiente Linux, ora puoi utilizzare la funzionalità di
caricamento dei file di AARI on the web senza alcun
problema. In precedenza, si verificava un errore di
accesso negato per la funzionalità di caricamento
dei file poiché la directory filestorage per la
memorizzazione dei file non veniva automaticamente
creata.

12342 -- Il pulsante Modifica non appare più abilitato per i
processi archiviati, estratti o clonati. In precedenza,
era possibile modificare i nomi dei processi che erano
stati archiviati, estratti o clonati, anche se le modifiche
non venivano salvate.

12342 -- Per qualsiasi elemento di un modulo, se utilizzi
l'opzione Rendi il campo non modificabile nel
generatore di moduli o la disabiliti durante l'esecuzione
del bot associato, le convalide del modulo applicate a
quell'elemento vengono annullate.
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Limitazioni

In alcuni scenari, se avvii un bot configurato per essere eseguito in una finestra virtuale,
quest'ultima si avvia e viene richiesto di accedere alla finestra con le tue credenziali.
Soluzione: Riavvia il sistema e lancia nuovamente il bot.

Quando si progetta un modulo, si possono creare riferimenti per elementi nascosti usando l'opzione
Elementi nascosti dalle proprietà del modulo. Tuttavia, dopo aver progettato il modulo, non è
possibile visualizzare o modificare le variabili tra gli elementi nascosti.

Dopo aver progettato un modulo con una regola a tendina assegnata al modulo, se si visualizza la
tendina in modalità di sola lettura, non sarà possibile visualizzare i dati modificati in modalità di sola
lettura.

In presenza dell'elemento Seleziona un file nel modulo, non è possibile caricare un file con
caratteri speciali (come , ( ) & ; - =) nel nome del file quando si esegue il bot.

Nell'interfaccia Web, quando sei su una pagina diversa da quella principale e la tua sessione di
accesso si disconnette e ti riporta di nuovo alla pagina di accesso, il parametro next= viene
mostrato nell'URL a tempo indeterminato. Questo può essere un problema poiché il parametro
next= viene utilizzato per il reindirizzamento dell'URL a una pagina precedente, ma attualmente
non è supportato.

Per l'elemento Casella di testo, la regola del modulo Non contiene non funziona.

Per l'elemento Rich Text Editor, la regola del modulo Contiene non funziona.

Per l'elemento Tabella, l'opzione Righe prima dello scorrimento può supportare solo fino a
quattro righe. Se specifichi cinque o più righe, questa opzione non è supportata e devi scorrere
manualmente.

Se si crea un modulo con gli elementi Documento ed Elenco a discesa, quando si tenta di
inviare questo modulo, si verifica un errore. Questo errore è dovuto allo schema dinamico del
modulo, come un campo a discesa riempito da un processo che è presente nel modulo con il campo
documento e che causa un errore.

Discovery Bot

Novità

Salvataggio della registrazione con un nome
Dopo aver registrato un processo, è possibile ora salvare la registrazione con un nome. Il nome
della registrazione viene visualizzato nella pagina Registrazioni  per il suddetto processo.
Registrare un processo aziendale Discovery Bot alla pagina 2348

Condivisione di una descrizione della registrazione
È ora possibile fornire una descrizione per la registrazione di un processo utilizzando la pagina
Registrazioni per il suddetto processo. Nella pagina Registrazioni, utilizza il campo Descrizione
per condividere con l'analista il contesto e lo scopo della registrazione. La descrizione fornita viene
visualizzata anche nel PDD.
Registrare un processo aziendale Discovery Bot alla pagina 2348
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Novità

Eliminazione di una registrazione
Dopo aver registrato un processo, se non si desidera sottoporre i dati della registrazione a un
analista per la revisione, è possibile eliminare la registrazione usando la pagina Registrazioni
del processo in questione. Nella pagina Registrazioni, utilizza l'opzione Elimina per eliminare la
registrazione.
Registrare un processo aziendale Discovery Bot alla pagina 2348

Registrazione dei processi aziendali con AARI Assistant
Ora è possibile utilizzare AARI Assistant per registrare i processi aziendali senza accedere alla
Control Room. Per registrare un processo aziendale, avviare AARI Assistant facendo doppio clic
sull'icona AARI sul desktop.
Registrazione di processi Discovery Bot con AARI Assistant alla pagina 2353

Miglioramenti alle opportunità personalizzate
Ora puoi aggiornare i costi e i risparmi potenziali per le opportunità personalizzate e salvare le
tue modifiche al diagramma di processo. I costi e i risparmi potenziali possono essere aggiornati
in qualsiasi momento, man mano che si rivedono i passi delle varie registrazioni e si apportano
cambiamenti all'interno del diagramma di processo.
Esame delle opportunità, conversione in bot e creazione di PDD alla pagina 2355

Miglioramento del PDD
Ora è possibile visualizzare l'intero diagramma di processo dall'interno del Discovery Bot facendo clic
sul link URL fornito nel PDD. Il PDD non visualizza il diagramma di processo se sono selezionati più
di 100 passi.
Esame delle opportunità, conversione in bot e creazione di PDD alla pagina 2355

Cosa è cambiato

Il documento di Process Discovery (PDD) ora visualizza i caratteri Unicode cinesi sia in formato
Word sia in PDF.

Correzioni

ID caso Service Cloud Descrizione

-- Utenti cloud: Quando si acquisiscono più di 250 passi, è ora possibile
creare un'opportunità personalizzata per l'automazione e generare un
PDD.

-- Ora puoi scaricare un PDD per opportunità e registrazioni
personalizzate senza alcun problema. In precedenza, si verificava un
errore a intermittenza e veniva visualizzato il seguente messaggio di
errore: Errore di generazione PDD

-- Un messaggio di errore viene ora visualizzato quando non è possibile
connettersi alla Control Room. Per esempio, questo si verifica quando
un certificato firmato o jolly viene utilizzato per la configurazione della
Control Room per distribuzioni On-Premises e tale certificato non è
stato preinstallato. Non risulta possibile caricare la pagina Processi.
Segui le istruzioni del messaggio per connetterti alla Control Room.
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Correzioni

ID caso Service Cloud Descrizione

00829246 Utenti di Cloud: Ora puoi scaricare un PDD per un'opportunità di
automazione creata con 200 o più passaggi. In precedenza, quando
veniva creata un'opportunità con 200 o più passaggi, selezionando
Scarica PDD si riceveva un errore.

-- Per le opportunità generate automaticamente e personalizzate, la
tabella Registrazioni ora funziona come previsto. In precedenza, si
verificava un errore intermittente.

00827381 Quando cerchi il pacchetto Recorder nell'UI giapponese, ora puoi
visualizzare il nome corretto del pacchetto Recorder.

La seguente tabella elenca le limitazioni identificate nella versione attuale:

Limitazioni

In rare situazioni in cui la CPU di un dispositivo è occupata, potrebbe non essere possibile acquisire
lo screenshot di registrazione dalla pagina Registrazioni per un processo. Tuttavia, le azioni
dell'utente, come la selezione del testo, sono disponibili nella pagina Registrazioni.

La seguente tabella elenca le limitazioni delle versioni precedenti applicabili anche a questa versione:

Limitazioni rispetto alle versioni precedenti

Quando aggiungi rami a sinistra e a destra del ramo principale, la sezione del diagramma di flusso
Registrazione del PDD potrebbe non acquisire l'intero flusso di lavoro del processo, comprendente
tutti i rami.

Feature deprecation for Discovery Bot

Review the deprecated feature to understand how it can impact your automation.

Discovery Bot red highlight
In the recording session, the red outline that highlights when you move the mouse over the area
to capture the action has been deprecated as of June 2021. The red outline is displayed in the
screenshot images when you review your captured steps from the Recordings page.
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IQ Bot

Novità

Versione a disponibilità limitata di Document Automation
Un gruppo selezionato di primi utilizzatori ora può utilizzare Document Automation per
automatizzare l'elaborazione dei documenti aziendali nella nuova soluzione di elaborazione dei
documenti intelligente nativa del cloud per Automation Anywhere.
Document Automation è integrato nella Control Room. Quando si crea un'istanza di apprendimento,
IQ Bot crea automaticamente bots RPA per estrarre e scaricare i dati e un processo AARI per
gestire l'intero processo. Le istanze di apprendimento non richiedono formazione. Invece, Document
Automation utilizza modelli pre-formati per elaborare fatture e ricevute.
Document Automation alla pagina 2553 | Intelligent Document Processing solutions feature comparison
matrix alla pagina 2561

Numero totale di pagine caricate per l'azione Elabora documenti
In Automation 360 IQ Bot, quando si utilizza l'action Elabora documenti dal package IQ Bot
Extraction per elaborare i documenti, è ora possibile visualizzare il numero totale di pagine caricate
sotto Dashboard > I miei totali
Utilizzo dell'action Elabora documenti IQ Bot alla pagina 1661

Controllo degli accessi basato sul ruolo (RBAC) disponibile
Automation 360 IQ Bot ora offre un controllo degli accessi basato sul ruolo (RBAC). Puoi usare
RBAC per gestire le autorizzazioni utente seguenti:
• Modifica istanza di apprendimento
• Elimina istanza di apprendimento
• Invia istanza di apprendimento in produzione
• Importa dominio

Definizione di un ruolo personalizzato per IQ Bot alla pagina 2478

Rotazione della chiave di crittografia come AAE_IQ Bot Admin
Con il ruolo AAE_IQ Bot Admin, ora puoi ruotare la chiave di crittografa cambiando il nome
dell'oggetto nella nuova pagina Amministrazione > Rotazione della chiave.
Rotazione della chiave esterna alla pagina 2529

Nuovo modello per Cognitive MLWeb Service
Nelle installazioni On-Premises di Automation 360 IQ Bot, è ora possibile ottenere un migliore
rilevamento delle caselle di controllo e delle tabelle quando si utilizza il nuovo modello di Cognitive
MLWeb Service.

Cosa è cambiato

Per le installazioni On-Premises di IQ Bot, MLScheduler Service nella finestra dei servizi di Microsoft
Windows è ora disabilitato per impostazione predefinita, per liberare risorse di sistema.
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Correzioni

ID caso Service Cloud Descrizione

00764550, 00765854 Effettuando la migrazione da Enterprise 11 a Automation 360, tutte le
istanze di apprendimento con dominio personalizzato che includono
campi in lingua cinese vengono ora visualizzate correttamente. In
precedenza, questi campi venivano popolati con valori errati al posto
dei caratteri cinesi.

00758208, 00632965,
00727063, 00715124,
00828988, 01251514

Il servizio MLScheduler è ora disabilitato su IQ Bot On-Premises e il
sistema non rallenta più o non smette di rispondere. In precedenza,
le funzioni automatiche di correzione e suggerimento, facenti parte
del servizio MLScheduler, utilizzavano molte risorse di sistema e
causavano il rallentamento o l'interruzione della risposta del sistema.

01757917 I documenti vengono ora correttamente classificati utilizzando
Microsoft Azure 3.2 OCR. In precedenza, a causa della deprecazione
dell'anteprima di Microsoft Azure OCR v3.2-anteprima.2, i documenti
rimanevano non classificati.

-- I documenti estratti con il comando Estrazione automatica vengono ora
elaborati correttamente. In precedenza, quando i documenti venivano
estratti usando il comando Estrazione automatica, le convalide del
gruppo di convalida predefinito non venivano applicate.

01261531 Quando si crea un'istanza di apprendimento e si usa il comando di
caricamento IQ Bot, la schermata viene visualizzata correttamente
senza alcun problema. In precedenza, questo causava il
ridimensionamento e l'alternanza tra caratteri grandi e piccoli, facendo
sfarfallare il display.

-- Per creare manualmente un gruppo, è ora necessario solo il ruolo
IQBot_admin. In precedenza, per creare manualmente un gruppo,
erano necessari entrambi i ruoli aae_basic e IQBot_admin.

-- Nella UI IQ Bot, per i gruppi creati manualmente, è ora possibile
visualizzare l'Etichetta del gruppo nella sua interezza. In
precedenza, era possibile vedere solo una parte dell'Etichetta del
gruppo.

-- I documenti il cui nome file inizia con un carattere speciale, come
un trattino (-), sono ora correttamente classificati ed elaborati. In
precedenza, questi documenti venivano trattenuti nella coda di
classificazione o non venivano elaborati.

01063054 Ora si può importare un'istanza di apprendimento con un nome lungo
(più di 50 caratteri) senza errori poiché il campo Etichetta supporta
più di 50 caratteri.

-- Per un'istanza di apprendimento di moduli standard, se si carica un
documento che contiene una tabella con una cella vuota, il documento
viene ora inviato a Validator di IQ Bot. In precedenza, i documenti con
celle di tabelle vuote venivano inviati alla cartella Operazione non
riuscita.

-- Non si verifica più alcun errore quando si esegue un bot contenente
actions dai packages IQ Bot Pre-processor, IQ Bot Classifier e OCR. In
precedenza, in questi casi, si verificava un errore "Asserzione fallita".
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Correzioni

ID caso Service Cloud Descrizione

01777853 Ora puoi creare istanze di apprendimento di moduli standard
utilizzando modelli prefromati con nomi di campo lunghi (fino a 250
caratteri). In precedenza, i modelli preformati con nomi di campo
lunghi causavano un errore.

Limitazioni

Quando si caricano documenti PDF vettoriali in una nuova istanza di apprendimento, alcuni
documenti vengono identificati come non classificati. In alternativa, se si convertono i documenti da
PDF a TIFF e li si caricano, i documenti vengono elaborati con successo.

Quando si esegue IQ Bot utilizzando le credenziali dell'account di servizio, se la password contiene
uno spazio, i registri IQ Bot non verranno aggiornati.

In alcuni casi, anche se il numero o l'importo corretto sono riportati accuratamente, le
regole di convalida di alcuni documenti avranno ancora esito negativo a causa di un errore di
arrotondamento e tali documenti verranno inviati per la convalida manuale.

Nelle formule, se utilizzi i delimitatori, come virgole o punti come separatori delle migliaia, la
convalida della formula ha esito negativo.
Soluzione
• Per la lingua inglese: Rimuovere tutti i delimitatori, come le virgole usate come separatore

delle migliaia.
• Per le altre lingue europee: Rimuovere tutti i delimitatori, come i punti usati come separatore

delle migliaia. Usa la convenzione numerica inglese per le convalide delle formule.

Se utilizzi la versione 12.4 di ABBYY FineReader Engine invece della versione 12.2, la funzione MICR
non supporterà l'estrazione dei dati dai documenti in lingua giapponese.

Dopo aver effettuato il backup dei database ed eseguito lo strumento Assistente migrazione DB, lo
strumento e i registri indicheranno che la migrazione è stata completata correttamente anche se il
database unificato non è stato creato.
Soluzione: Assicurati di installare entrambe le versioni x86 e x64 del pacchetto Microsoft Visual C+
+ 2015-2019 Redistributable.

Bot Insight

Cosa è cambiato

Dati Data/ora di inizio ora in formato standard
Quando si esportano dati in Microsoft Excel, il formato della data sarà esportato in base al formato
della data del widget.
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Correzioni

ID caso Service Cloud Descrizione

-- Ora, quando utilizzi una rete proxy, cliccando su Analizza, il
dashboard di rete genera un'analisi. In precedenza, questo dashboard
non generava alcuna analisi.

-- Quando esegui un bot inserito in una cartella pubblica e poi estratto
in una cartella privata, la data dell'ultimo aggiornamento viene ora
visualizzata con precisione. In precedenza, l'ultima data aggiornata
veniva visualizzata come non valida.

01252869, 01259449 La dashboard Azienda è ora visibile agli utenti assegnati al ruolo di
amministratore BI e con licenza utente BI. In precedenza, gli utenti
con questo ruolo e licenza non erano in grado di accedere a questa
dashboard.

Limitazioni

Impossibile eseguire il drill-down dei dati utilizzati nel gruppo per durata
Quando Raggruppa per è selezionato come durata (ora/data) nel widget, il drill-down è
applicabile solo a un singolo livello. Se provi a fare il drill-down dei dati al secondo livello oppure
oltre, potresti riscontrare l'errore seguente: Nessun dato trovato.

(ID caso Service Cloud: 00777595) Quando tenti di aggiornare i dati in un foglio di lavoro di
Microsoft Excel, potresti riscontrare un errore di autenticazione da più tentativi simultanei attraverso
finestre e schede aperte.
Soluzione
1. Nell'applicazione desktop Power BI, vai a File > Opzioni e impostazioni > Opzioni.
2. Dalla sezione File corrente, seleziona Carica dati.

Nota:  Non selezionare Carica dati dalla sezione Globale.

3. Disattiva la casella di controllo Abilita il caricamento parallelo delle tabelle.

Note sulla versione Automation 360 v.23
Data di rilascio:30 dicembre 2021

Riesamina le novità e le modifiche apportate e le correzioni e le limitazioni della versione Automation 360
v.23 (Build 11513). Build 11513 sostituisce le build 11499 e 11486.

Importante:
• Questa build include la libreria Apache Log4j2 versione 2.17.1 per risolvere il problema dell'esposizione

alle vulnerabilità CVE-2021-44832, CVE-2021-45105, CVE-2021-44228 e CVE-2021-45046.
I pacchetti di comandi non sono aggiornati alla versione 2.17.1 della libreria Apache Log4j2, tranne Bot
Agent. In fase di esecuzione, i pacchetti useranno la libreria Apache Log4j2 versione 2.17.1 tramite Bot
Agent, pertanto non saranno esposti. Come ulteriore misura di sicurezza, per impostazione predefinita
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il programma di installazione Automation 360 v.23 Bot Agent disabilita anche la funzionalità di ricerca
della libreria Apache Log4j2.
Scansioni di sicurezza di terze parti potrebbero trovare tracce di versioni precedenti della libreria Apache
Log4j2. Tuttavia, con l'aggiornamento a Automation 360 v.23 e la mitigazione in atto, verranno escluse
eventuali esposizioni alle vulnerabilità. Per ulteriori informazioni, consulta FAQs related to Automation
Anywhere Releases regarding zero-day vulnerabilities (CVE-2021-44228, CVE-2021-45046) (A-People login
required).

• Questa build include anche le correzioni dei seguenti problemi:
• Durante l'aggiornamento da Automation 360 v.22 a v.23, i processi in background correlati alle

sincronizzazioni del server delle licenze cloud venivano eliminati a causa del nome errato del
processo di licenza.

• Durante l'installazione o l'aggiornamento a Automation 360 v.23 per le distribuzioni di On-Premises, i
file di log non venivano aggiornati per alcuni servizi aggiuntivi.

• Se non si disponeva dell'autorizzazione Visualizza pacchetto, le distribuzioni di bot non andavano
a buon fine quando si programmava o si eseguiva bot.

• Migrazione
11.x e 10.x | solo 11.x

• RPA Workspace
Novità | Cosa è cambiato | Correzioni | Correzioni di sicurezza | Limitazioni

• AARI
Novità | Cosa è cambiato | Correzioni | Limiti

• Discovery Bot
What's new | Fixes | Limitations | Feature Deprecation

• IQ Bot
Novità | Cosa è cambiato | Correzioni | Limiti

• Bot Insight
Cosa è cambiato | Correzioni | Limitazioni

Aggiornamento a questa versione

L'aggiornamento di Build 11513 per Automation 360 v.23 include la versione 2.17.1 della libreria Log4j2 e
le correzioni. Se si utilizza la precedente Build 11499 v.23 (con la versione 2.17.0 della libreria Log4j2) o la
Build 11486 (con la versione 2.16.0 della libreria Log4j2), eseguire l'aggiornamento a Build 11513 per la
versione aggiornata della libreria Log4j2 e le correzioni.
È anche possibile eseguire l'aggiornamento a Automation 360 v.23 dalle tre versioni precedenti (ovvero
dalle versioni n-3, dove n si riferisce alla versione più recente). Le seguenti versioni precedenti sono
certificate per l'aggiornamento a questa versione:
• v.22 (Build 10526)
• v.21 (Build 9664, 9642, 9595)
• v.20 (Build 8815)

Puoi passare direttamente alla versione v.23 da una qualsiasi di queste build (vedi Aggiornamento alla
versione di Automation 360 più recente alla pagina 1063). Se non utilizzi una versione n−3, puoi aggiornare
Automation 360 a una delle tre versioni certificate (sopra indicate) prima di passare a questa versione.
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Se effettui l'aggiornamento direttamente a questa versione da Automation 360 On-Premises v.20 o v.21,
rimuovi i seguenti file e cartelle Bot Agent:
• C:\Windows\System32\config\systemprofile\AppData\Local\AutomationAnywhere

\AA-DB.mv.db
• C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-resources

Importante:  Per utilizzare le nuove funzionalità della versione v.23 (compresi gli aggiornamenti dei
pacchetti Recorder) e per correggere le vulnerabilità di Log4j2, aggiorna Bot Agent per questa versione.
L'aggiornamento di Bot Agent dalla versione precedente non è richiesto per eseguire il bots esistente come
Bot Runners.

Per informazioni sull'aggiornamento a questa versione, consulta le seguenti risorse:
• Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina

1043
• Compatibility with release builds alla pagina 1026

Per gli aggiornamenti più recenti delle estensioni di Automation 360 per Google Chrome, Microsoft Edge e
Mozilla Firefox, vedi Browser extensions for Automation 360 alla pagina 718.

Funzionalità di migrazione

Funzionalità di Enterprise 11 e Enterprise 10

MetaBots contenenti oggetti collegati
Migrazione di MetaBots che contengono un oggetto collegato al tipo di riproduzione testo collegato
all'oggetto in modalità di riproduzione oggetto, un oggetto collegato al tipo di riproduzione
immagine collegato all'oggetto tipo di riproduzione immagine e un oggetto collegato al tipo di
riproduzione coordinata collegato all'oggetto tipo di riproduzione coordinata.

Migrazione di bots con i seguenti attributi:
• Bots con variabili che contengono dati di dimensioni superiori a 64 KB (ID caso Service Cloud:

00716311,00756449,00819149)
Il processo di migrazione memorizza i dati in un file di testo. Il file di testo viene caricato nel
Cloud Control Room e viene utilizzato nel bot migrato.

• MetaBots con DLL che restituiscono valori di tipo elenco e matrice con qualsiasi combinazione di
delimitatori e memorizzano questi valori negli appunti

• Ora puoi effettuare la migrazione dei MetaBots con la modalità riproduzione immagine che
utilizza l'azione Ottieni visibilità

• Ora puoi migrare bots con le azioni Ottieni indice selezionato e Ottieni testo selezionato
per la tecnologia UI Automation utilizzata nel comando Clonazione dell'oggetto e nelle
schermate MetaBot.

• Ora puoi migrare i bots che automatizzano le applicazioni con il Tipo di tecnologia Java
utilizzando il comando Clonazione dell'oggetto con l'azione Ottieni dati di tutti gli
elementi figlio.

Bots con diversi casing variabili
Quando migri un bot che ha passato una variabile da un TaskBot a una logica MetaBot o da una
logica MetaBot a un TaskBot, e se il casing del nome della variabile viene modificato nella logica
MetaBot, il processo di migrazione aggiorna il nome della variabile con lo stesso casing di quello del
bot corrispondente alla logica MetaBot migrata nel TaskBot genitore.
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Funzionalità di Enterprise 11 e Enterprise 10

Migrazione di bots con immagine del localizzatore (ID caso Service Cloud: 00754508,
00776192)
È ora possibile eseguire la migrazione di bots che contengono immagini acquisite con il comando
Object Cloning.

I MetaBots come dipendenze non vengono scaricati
Il processo di migrazione non scarica MetaBots disponibili come dipendenze. Questa restrizione è
per evitare di scaricare MetaBots e creare copie multiple degli stessi MetaBots essendo questi già
disponibili nell'archivio della Control Room.

Nuova action nel pacchetto Automazione legacy per la migrazione (ID caso Service Cloud:
00797140, 00849161)
Usa l'action Ottieni ritardo pressione di tasti per far corrispondere la durata del ritardo definita
in Enterprise 11 bots per il comando Inserisci sequenze di tasti e simulare lo stesso valore in
Automation 360 per l'action Simula sequenze di tasti.

Notifica relativa a bots con problemi di report Bot Scanner
Il report del Bot Scanner ora contrassegna Enterprise 11 o Enterprise 10 bots che hanno problemi
e quindi richiedono un'azione o una revisione. Per esempio, i bots che presentano problemi di
sicurezza o i bots relativi a variabili inesistenti sono contrassegnati da un'icona nel messaggio di
azione o di revisione.

Miglioramento della convalida delle bots migrate
• Sono ora disponibili ulteriori convalide a tempo di compilazione per convalidare un bot in fase

di esecuzione. Ad esempio, se un bot padre richiama un bot figlio e il bot figlio ha errori di
compilazione, questi errori vengono visualizzati quando si cerca di eseguire il bot padre. Questo
assicura che un errore non si verifichi nel mezzo di un'automazione o la renda incompleta.
Questa funzionalità permette di identificare in modo proattivo tutti i bots migrati che contengono
errori di compilazione. I bots migrati con errori di compilazione sono mostrati in Operazione
riuscita con revisione del Report di migrazione e ciò consente di ottenere una lista di bots
che richiedono la tua attenzione.
Per abilitare la funzionalità di convalida bot, passa ad Amministrazione > Impostazioni > 
Bot > Convalida bot e impostala su Attiva. Consulta Impostazioni alla pagina 2721.

• Bot Migration Wizard mostra ora i dettagli dell'errore di convalida per ogni bot nei risultati della
migrazione del bot. I dettagli sugli errori ti aiutano a rivedere e ad agire sui bots per cui è stata
effettua la migrazione, permettendoti così di risparmiare tempo.
Migrazione dei bots di Enterprise alla pagina 1216

Assistente alla migrazione del bot migliorato
L'assistente migrazione è ora unito all'assistente errori per fornire una visione completa di tutte le
righe di un bot che richiedono una revisione o un'azione da parte dell'utente, o che contengono
errori e richiedono quindi che siano risolti. Questa funzionalità è utile per identificare rapidamente le
aree dei bots che richiedono attenzione.

Supporto per il driver a 32 bit per collegare il database (ID del caso Service Cloud:
00757466)
Per abilitare la migrazione dei Enterprise 11 bots con VBScript, i driver a 32 bit sono ora supportati
in Automation 360 per connettere il database.
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Funzionalità esclusive di Enterprise 11

Migrazione di bots con i seguenti attributi:
• Bots che includono immagini acquisite con il comando Object Cloning, il comando OCR

> Acquisisci area, il comando Integrazione app > Acquisisci area e l'azione Clic del
mouse.

• Bots che contengono un corpo di e-mail HTML con riferimenti locali alle immagini, se le immagini
di riferimento sono disponibili sulla macchina Bot Runner (ID del caso Service cloud: 00780065,
00790657, 00827527, 00822092, 00928116, 01181845)

• Bots che contengono comandi di Microsoft Excel con estensioni di file come .ods, .htm,
.html, .mht, .mhtml, .slke .pdf per aprire un file Excel (ID del caso Service Cloud:
00799071)

• MetaBots che usano la variabile credenziali di tipo non stringa per passare un valore numerico
come input a una funzione DLL

RPA Workspace

Novità

Funzionalità di amministratore avanzateCon una licenza appropriata, gli amministratori
Automation Anywhere Control Room possono ora creare utenti RPA validi in base all'autenticazione
con nome utente e password, quindi scegliere di non richiedere l'autenticazione in tempo reale
tramite risposta e-mail. Questa funzionalità consente agli amministratori di inviare nuovamente le e-
mail di autenticazione "Ti diamo il benvenuto" senza dover reimpostare le credenziali assegnate agli
utenti RPA.

Microsoft Edge (Chromium) supportato per Control Room e Bot Agent
È ora possibile eseguire operazioni di Control Room e installare e registrare il proprio dispositivo Bot
Agent usando Microsoft Edge basato sul browser Chromium.
Requisiti del browser per RPA Workspace alla pagina 866

Supporto per Azure Key Vault
Automation 360 ora supporta Azure Key Vault ed è ora possibile recuperare quanto segue da un
archivio chiave esterno:
• Active Directory (AD), account dei servizi e credenziali SMTP
• Credenziali di accesso automatico
• Credenziali per automazioni

Convalida Bot
Il controllo di convalida Bot avviene per i nuovi bots e quando si esegue un bot. Gli amministratori
Control Room possono ora attivare o disattivare la funzionalità di convalida Bot. Per impostazione
predefinita, questa funzionalità è disattivata per ogni Control Room.
Migrazione dei bots di Enterprise alla pagina 1216

Variabile Credential Vault supportata in Esegui funzioneaction del package DLL
Come Bot Creator, ora puoi utilizzare la variabile Credential Vault o la variabile di tipo credenziali per
il tipo dati Number e passarla come parametro di input nella funzione DLL.
Utilizzo dell'action Esegui funzione alla pagina 1488
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Novità

ID file supportato nell'action Verifica autorizzazione del package Google Drive (ID caso
Service Cloud: 00777716)
L'action Verifica autorizzazione del package Google Drive supporta ora l'opzione ID file per fare
riferimento ai file disponibili nella cartella Condiviso con me di Google Drive. Fornendo l'ID file,
ora puoi verificare l'accesso Leggi, Scrivi o Elimina concesso nella cartella Condiviso con me
dei file di Google Drive.
Pacchetto Google Drive alla pagina 1602

Nuove credenzialipackage
Ora puoi usare l'action Assegna nel package credenziali per assegnare una stringa non sicura o
una variabile direttamente alla variabile credenziali.
package Credenziale alla pagina 1436

Sicurezza dei servizi Web supportata nel package SOAP Web Service (ID caso Service
Cloud: 00481836)
Come Bot Creator, è ora possibile fornire variabili di credenziali nei dati non elaborati dell'action
Servizio Web SOAP. Puoi creare una variabile credenziali, mappare le credenziali con un nome di
riferimento nel mapper di credenziali e usare il nome di riferimento nei dati non elaborati. Poiché
questo assicura che tutti i dati relativi alla sicurezza possano essere definiti nel Credential Vault e
le credenziali possano essere usate nei bots, è possibile distribuire tranquillamente le attività senza
compromettere la sicurezza.
Esempio di utilizzo dell'azione Servizio Web SOAP alla pagina 2076

Nuova opzione nel package SOAP Web Service
Utilizza l'opzione Crea Xpath nel package SOAP Web Service per estrarre i valori dalla risposta
SOAP. È ora possibile specificare l'espressione Xpath o selezionare il nodo appropriato dal corpo
della risposta e memorizzare l'output in una variabile.

Server di Outlook supportato in Cambia stato, Salva messaggio ed Elimina actions (ID
caso Service Cloud: 00544534, 00557623, 00642506, 00659724, 00763565, 00680801, 00803975,
00818304, 00819362)
Nel package Email, per automatizzare un compito è ora possibile stabilire una connessione con il
server Outlook per le actions Cambia stato, Salva messaggio ed Elimina.

Lettura di e-mail dalla casella di posta condivisa in Microsoft Outlook (ID caso Service
Cloud: 00728579, 00831622)
Per automatizzare le attività legate alla posta elettronica, è ora possibile selezionare un account
condiviso in Microsoft Outlook in modo che i messaggi e-mail possano essere letti dalla casella di
posta condivisa.

Nuovi tipi di codifica supportati nell'action Scrivi su file del package Data Table (ID caso
Service Cloud: 00767158)
Quando si utilizza l'action Scrivi su file per scrivere i dati da una variabile di tipo Tabella in un file
CSV o TXT, è ora possibile utilizzare i seguenti tipi di codifica dall'elenco di codifica:
• UTF-8: Funziona come UTF-8 senza BOM
• UTF-8 con BOM (in precedenza UTF-8)
• UTF-16LE
• Maiusc-JIS (codifica giapponese)
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Novità

Funzionalità di salvataggio automatico in Bot editor
In Bot editor, quando si utilizzano actions per creare un'automazione, quando un bot non viene
salvato manualmente, viene eseguito un salvataggio automatico e il bot salva ora automaticamente
le modifiche per eventi specifici.

Nota:  La funzionalità di salvataggio automatico è attualmente disponibile solo per eventi specifici.

Alcuni degli eventi che supportano la funzionalità di salvataggio automatico sono i seguenti:
• Registratore: Quando si crea un bot con determinate actions e si fa clic su Registratore,

l'evento viene salvato e al termine della registrazione l'evento viene salvato in modo automatico.
• Gestione variabili: Quando si crea o si modifica una variabile per inserirla in un'action, le

modifiche vengono salvate.

Nota:  La funzionalità di salvataggio automatico non è supportata quando si elimina una
variabile o la si inserisce premendo F2 per aprire l'elenco delle variabili.

• Menu Azioni (puntini di sospensione verticali): Quando si seleziona una qualsiasi action da
questo menu, per esempio Pacchetti, l'evento viene salvato automaticamente. Quando si
applica una qualsiasi modifica alla pagina Pacchetti e si ritorna al Bot editor, l'evento viene
salvato.

• Trova un file: Quando fai clic sull'icona Trova un file, il bot viene salvato se non è stato salvato
manualmente. Inoltre, dopo aver fatto clic sull'opzione Aggiungi, il bot viene automaticamente
salvato.

• Finestre di dialogo: Quando una finestra di dialogo viene aperta, questa viene automaticamente
salvata se vengono fatte delle modifiche.

Nota:  Il salvataggio automatico viene attivato solo per le finestre di dialogo di primo livello e
non per quelle annidate.

• Eliminazione di variabili: Quando si eliminano variabili inutilizzate, l'evento viene salvato.
• Modifica del nome di un Bot: Se si modifica il nome di un bot, l'evento viene salvato.

Nuova opzione nel FTP / SFTP package (ID del caso Service Cloud: 00792346)
Utilizza l'opzione Credenziali quando ti connetti con il tipo di server FTP sicuro per automatizzare
un'attività. Ora puoi usare nome utente e password per l'autenticazione.
Connect action alla pagina 1578

Miglioramenti al AISense Recorder
AISense Recorder supporta ora l'automazione di applicazioni che usano il portoghese brasiliano e
una combinazione di interfacce in portoghese brasiliano e inglese.
AISense per la registrazione di attività da applicazioni remote alla pagina 1965

Supporto per l'ancora di cattura in AISense Recorder
AISense Recorder supporta ora l'opzione Acquisisci ancoraggio. Quando si esegue un bot
per cercare un oggetto in un'applicazione in cui l'ancoraggio cambia frequentemente, è possibile
utilizzare Acquisisci ancoraggio per sovrascrivere l'ancoraggio predefinito e selezionarne
manualmente uno per rilevare l'oggetto.
Edit a task recorded using AISense alla pagina 1969
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Supporto migliorato quando si seleziona la proprietà Oggetto nel package Recorder
Dopo aver acquisito un oggetto utilizzando l'action Registratore > Acquisisci, ora puoi
selezionare il nome di una particolare proprietà dell'oggetto dall'elenco delle proprietà disponibili
per recuperare il valore della proprietà dell'oggetto utilizzando l'action Ottieni proprietà. L'elenco
include i nomi di proprietà suggeriti dai criteri di ricerca nella tabella Proprietà oggetto.
Pacchetto Recorder alla pagina 1751

Miglioramenti al package Numero
• Nell'action Casuale del package Numero, è possibile specificare e limitare il numero di cifre

decimali richieste nel numero casuale generato nell'output.
• Il campo Salva il risultato in una variabile numerica esistente è ora rinominato come

Salva il risultato in una variabile.

Number package alla pagina 1695

Miglioramenti al package Attendi
Utilizza la nuova funzionalità Acquisisci regione nell'action Attendi la modifica della
schermata del package Attendi per acquisire una regione specifica in un'applicazione tracciando
un rettangolo intorno ad essa in modo che il bot acquisisca automaticamente le coordinate di
questa regione. Puoi effettuare le seguenti operazioni:
• Acquisire una regione specifica in un'applicazione Windows.
• Visualizzare un'anteprima dell'immagine acquisita nella finestra Anteprima.
• Riacquisire una regione se l'immagine nella finestra Anteprima non è conforme ai requisiti

dell'utente.

Le coordinate sono rinominate come segue:
• Sinistra è ora X
• In alto è ora Y
• Destra è ora Larghezza
• In basso è ora Altezza

Using Wait for screen change action alla pagina 1924

Miglioramento del package Stringa
Nell'action Estrai testo del package Stringa è ora possibile estrarre una sottostringa da una stringa
sorgente specificata che ricorre più di 1000 volte in un file con un limite massimo di 999999.

Miglioramento di Condizioni file nel package Se
È ora possibile usare la nuova condizione Estensione del file dall'elenco Condizione nel package
Se per controllare le estensioni dei file e poi eseguire le actions in base ai risultati.
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Supporto per iFrame interdominio nei browser Google Chrome e Microsoft Edge
Chromium (ID caso Service Cloud: 00825656)
Ora è possibile acquisire e automatizzare gli oggetti all'interno di un iFrame interdominio nei
browser Google Chrome e Microsoft Edge Chromium utilizzando Registratore > Acquisisci
o l'opzione Avvia la registrazione. Dopo aver acquisito un oggetto all'interno di un IFrame
interdominio, il percorso del frame è memorizzato, per impostazione predefinita, nella proprietà
FrameDOMXPath.
La nuova proprietà FrameDOMXPath identifica il percorso del frame in cui si trova l'oggetto. È
necessario selezionare questa proprietà per eseguire il bot con successo per acquisire oggetti su un
IFrame interdominio.

Nota:  Questa funzionalità è disponibile per i bots creati utilizzando dalla versione
2.4.0-20211016-070100 del package Recorder in poi.

Pacchetto Recorder alla pagina 1751

Supporto per l'automazione di Microsoft Edge Chromium con modalità di compatibilità
Internet Explorer (ID caso Service Cloud: 00767502, 00787186)
È ora possibile automatizzare le applicazioni web in esecuzione su Microsoft Edge Chromium,
abilitando la modalità di compatibilità Internet Explorer, utilizzando il Universal Recorder dove gli
oggetti vengono acquisiti utilizzando la tecnologia HTML.
Record a task with the Universal Recorder alla pagina 1951

Supporto della sessione globale per l'iteratore del loop basato su Excel advanced
È ora possibile usare l'opzione Sessione globale quando si esegue un loop su ogni riga di un
foglio di lavoro Excel advanced. Utilizza l'opzione Sessione globale per condividere una sessione
di Microsoft Excel tra più bots in modo da poter utilizzare lo stesso foglio di lavoro Excel tra questi
bots.
Using the Open action for Excel advanced alla pagina 1539

Miglioramento a Excel advanced package (ID del caso Service Cloud: 00799071)
Usa l'action Apri del package Excel advanced per aprire i file con estensioni .ods, .htm, .html,
.mht, .mhtml, .slk e .pdf.
Excel advanced package alla pagina 1533

Estrazione di una versione specifica di un bot
Per modificare un bot nella pagina Automazione della Control Room, quando si estrae un bot dallo
spazio di lavoro Pubblico a uno Privato, è ora possibile scegliere una versione specifica del bot
insieme alle sue dipendenze utilizzando le nuove Opzioni avanzate.
Check out a single bot alla pagina 2000

Nuove API per i dispositivi
Ora puoi allocare i dispositivi predefiniti utilizzando le nuove API introdotte nella sezione v1/
Devices. Scegli di impostare o non impostare un dispositivo specifico come dispositivo di
distribuzione predefinito per un utente specificato utilizzando rispettivamente le seguenti API:
• /runasusers/default
• /runasusers/default/unset
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Validità della chiave API configurabile (ID caso Service Cloud: 00763420)
Si può ora configurare la validità della chiave API usando la funzionalità Durata della chiave
API disponibile in Amministrazione > Impostazioni > Configurazione della sicurezza in
Automation 360. Si può impostare una validità minima di 1 minuto e massima di 45 giorni.

Confronto delle versioni Bot
Ora puoi confrontare varie versioni di bots nello spazio di lavoro pubblico. Puoi usare l'opzione
Confronta versioni per selezionare due versioni di un bot e confrontarle per rilevare le differenze,
e le modifiche nel flusso di lavoro vengono evidenziate come riferimento. Puoi anche vedere le
differenze nelle azioni, nei pacchetti, nei trigger e nelle variabili tra le versioni.
Compare bot versions alla pagina 2007

Supporto dell'etichetta di produzione nel flusso di lavoro di sviluppo del bot
Ora è possibile assegnare una Etichetta di produzione a una particolare versione di un bot. Dopo
aver assegnato un'etichetta, è possibile eseguire o esportare bots con una versione bot di propria
scelta. È possibile selezionare la versione associata a un'etichetta di produzione per pianificare,
eseguire, accodare e attivare flussi di lavoro di sviluppo di bot.
Assign label to a bot alla pagina 2006

Accesso a Formazione e certificazione RPA di Automation Anywhere
Nel Centro assistenza Automation 360 è stato aggiunto un link diretto a Formazione e certificazione
RPA di Automation Anywhere.
Automation Anywhere University: RPA Training and Certification (A-People login required)

Cosa è cambiato

Consigli Bot Scanner
Bot Scanner consiglia ora di procedere alla migrazione (con o senza revisione o azione) quando il
95% o più del 95% dei bots può essere migrato.

Assegnare la variabile credenziali alle variabili di tipo non credenziali per i bots migrati
Per i bots migrati, Automation 360 non impedisce più di assegnare la variabile credenziali a una
variabile di tipo non credenziali in modo insicuro (non sicuro). Quindi ora è possibile eseguire con
successo bots migrati che utilizzano il comando Esegui logica per passare la variabile credenziali a
una variabile di tipo non credenziali in modo insicuro.
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Miglioramenti al Recorder package
L'algoritmo di ricerca per il package Recorder è ora migliorato in modo che quando si esegue un
bot un oggetto viene acquisito solo se le sue proprietà corrispondono esattamente al criterio di
ricerca selezionato nella tabella Proprietà oggetto. Se le proprietà dell'oggetto non corrispondono
esattamente al criterio di ricerca, allora il bot ha esito negativo e viene visualizzato un messaggio
di errore. Tuttavia, se il criterio di ricerca include un carattere jolly, allora il bot acquisisce il primo
oggetto che corrisponde al criterio.
Per esempio, per acquisire una casella di testo da un'applicazione che ha tre caselle di testo
denominate nome1, nome2 e nome3, se si seleziona Nome HTML come criterio di ricerca,
inserire il valore nome nel campo nome HTML ed eseguire il bot, in questo caso il bot avrà un esito
negativo visualizzando un messaggio di errore poiché la casella di testo con nome HTML nome
non esiste. Tuttavia, nel campo Nome HTML, se si inserisce nome* e si esegue il bot, allora il bot
acquisirà la prima casella di testo corrispondente al criterio.
In precedenza, in assenza di oggetti con proprietà corrispondenti esattamente al criterio di ricerca,
invece di dare un esito negativo, il bot acquisiva il primo oggetto le cui proprietà corrispondevano
parzialmente al criterio di ricerca. Per esempio, nell'esempio precedente, selezionando Nome
HTML come criterio di ricerca, inserendo il valore nome nel campo Nome HTML ed eseguendo
il bot, invece di dare esito negativo, il bot avrebbe acquisito la prima casella di testo parzialmente
corrispondente al criterio.

Nota:  Questo miglioramento è disponibile per i bots creati utilizzando dalla versione
2.4.0-20211016-070100 del package Recorder in poi. Per utilizzare questa funzionalità nei bots
creati utilizzando una versione precedente del package, è necessario acquisire nuovamente gli
oggetti.

Miglioramenti al package File (ID caso Service Cloud: 00755631, 00780237)
• Nell'action Copia file Control room del package File, la nuova opzione Percorso file

dinamico nel campo File Control room permette ora l'utilizzo di variabili nel percorso del file
per copiare un file dall'archivio Control Room dove il percorso del file è dinamico.

• Alcune azioni e proprietà nel package File sono state ora aggiornate come segue:
• L'action Copia è stata rinominata Copia file desktop.
• L'action Scarica file CR è stata rinominata Copia file Control room.
• Nell'action Copia file Control room sono stati rinominati i seguenti campi:

• Il campo Seleziona un file Control room è stato rinominato File Control room.
• Il campo Salva file CR nel percorso è stato rinominato Percorso file di

destinazione.

• Nell'action Copia file Control room, il campo File Control room ha ora due nuove
opzioni: Percorso file statico e Percorso file dinamico.
L'opzione Percorso file statico è una funzionalità esistente nel campo File Control room
che permette di sfogliare l'archivio Control Room e selezionare il file. Quando si sfoglia
l'archivio utilizzando Percorso file statico, i file con estensione .bot non vengono più
visualizzati.

Nota:  La ridenominazione delle actions all'interno del package File non ha impatto sui bots
esistenti che utilizzando queste actions.

File package alla pagina 1562
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Modifiche all'azione Connetti in FTP / SFTP package (ID del caso Service Cloud: 00792346)
Le seguenti modifiche sono apportate all'action Connetti:
• Il tipo di server SSH FTP è ora rinominato FTP sicuro.
• Quando selezioni il tipo di server FTP sicuro, il tipo di autenticazione Credenziali utente è ora

rinominata Nome utente e password.

Nota:  Da questa versione, se utilizzi le credenziali Secure FTP in FTP Secure, il bot avrà esito
negativo. Invece, ti consigliamo di usare la nuova opzione Credenziali disponibile in FTP
sicuro per connetterti al server Secure FTP.

• Modifica in action Connetti: Se hai creato dei bots utilizzando l'action Connetti usando
Automation 360 v.22 e precedenti e lo aggiorni alla v.23, i bots mostrano alcuni degli elementi
dell'action Connetti come obsoleti a causa di cambiamenti nell'interfaccia. Tuttavia, i bots
esistenti continueranno a funzionare in modo corretto. Ti raccomandiamo di creare i nuovi bots
utilizzando l'action Connetti disponibile da questa versione.

Supporto alla copia di una o più variabili (ID del caso Service Cloud: 00549368, 00751052,
01260498)
Ora puoi copiare una o più variabili da un bot e poi incollarle in un altro bot. In precedenza,
l'operazione di copia copiava anche le actions insieme alle variabili.

Supporto per caratteri riservati in Distinguished Names (DN) per Active
DirectoryControl Room (ID caso Service Cloud: 01133364, 00952301)
È ora possibile utilizzare caratteri riservati, come la virgola (,), in DN o nel nome utente di una
Control Room configurato per gli utenti Active Directory.

La tabella seguente elenca le correzioni e le build in cui sono state corrette. La build 11513 è quella più
recente e include le correzioni delle build precedenti.

Correzioni

Crea ID caso Service
Cloud

Descrizione

11513 00797196, 00818347 Aggiornamenti all'API dello spazio di lavoro
privato ( /v2/repository/workspaces/
{workspaceType}/files/list):
• Solo gli utenti autorizzati dell'area di lavoro privata

possono elencare i bot dall'area di lavoro privata.
• L'amministratore non può elencare i bot dell'area

di lavoro privata.
• Solo gli utenti autorizzati dell'area di lavoro

pubblica non possono elencare i bot privati.
• Un utente autorizzato dell'area di lavoro privata

non può elencare i file dell'area di lavoro privata di
un altro utente.
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Crea ID caso Service
Cloud

Descrizione

11513 00808478,
00814198, 01260666

Se sei un amministratore della Control Room, quando
apporti una modifica ai permessi di visualizzazione
di alcune cartelle bot in modo che possano essere
visualizzate solo da utenti specifici, tale modifica
viene ora applicata correttamente. In precedenza,
le modifiche apportate alle autorizzazioni di
visualizzazione delle cartelle bot non venivano
applicate correttamente.

11513 Durante l'aggiornamento da Automation 360
v.22 a v.23, i processi in background correlati alle
sincronizzazioni del server delle licenze cloud non
vengono più eliminati a causa del nome errato del
processo di licenza.

11513 01753484, 01754939 Ora è possibile distribuire (pianificare ed eseguire)
bots da Control Room senza problemi se si dispone
dell'autorizzazione Visualizza pacchetto.

Nota:  L'autorizzazione Visualizza pacchetto è
necessaria per distribuire (pianificare ed eseguire)
bots da Control Room.

11513 -- Durante l'installazione o l'aggiornamento a
Automation 360 v.23 per le distribuzioni di On-
Premises, i file di log vengono aggiornati per tutti
i servizi senza alcun problema. In precedenza, i
file di log di alcuni servizi aggiuntivi non venivano
aggiornati con le informazioni o le indicazioni
temporali delle attività.

11486 00793800 Con la migrazione a questa versione vengono risolti
i problemi relativi a JRE durante l'installazione della
Control Room su macchine che utilizzano server
Microsoft Hyper-V. The following error no longer
occurs: Unknown Failure. Please check
 the database login credentials and
 check if this machine has a network
 connection to the database server.

11486 00815340 I nomi delle cartelle utente con parti iniziali o
convenzioni di denominazione simili non visualizzano
più le cartelle che condividono le convenzioni di
denominazione ma non i permessi assegnati o
specifici dell'utente.

11486 00836898, 01259938 L'utilità di migrazione al cloud ora include una logica
ottimizzata che consente di caricare i dati anche
quando la rete è connessa tramite un server proxy.

© 2023 Automation Anywhere. All rights reserved.     319



    Automation Anywhere - Learn

Correzioni

Crea ID caso Service
Cloud

Descrizione

11486 00817173 Ora è possibile eseguire una funzione Esegui
DLL quando i parametri di input e di output sono
impostati su un valore Stringa e il valore Data e
ora viene tramesso come parametro Stringa. In
precedenza, il valore Data e ora veniva convertito e
non era visualizzato come previsto.

11486 00754305, 00769128 L'assegnazione di tag di configurazione funziona ora
correttamente, in base alle impostazioni configurate
nel file nodemanager-logging.xml. In precedenza,
i registri del gestore di nodi e di avvio dei bot
venivano eliminati dopo due giorni o se il numero di
registri aumentava di quantità specifiche a causa di
problemi di etichettatura con tag come i seguenti:
"IfLastModified age" e "DirectWriteRolloverStrategy"

11486 Quando si decide di selezionare o deselezionare tutti
i bots e le dipendenze, è ora possibile selezionare o
deselezionare la casella di controllo Seleziona tutto
senza alcun problema. In precedenza, dopo aver
selezionato la casella di controllo Seleziona tutto,
quando si deselezionava la casella di controllo, non
funzionava come previsto e si rendeva necessario
deselezionare i bots e le dipendenze individualmente.

11486 00798037, 00814184 Le etichette Gestisci e Amministrazione nel
riquadro di navigazione sono ora aggiornate per
garantire che i ruoli e i permessi siano distinti
nelle seguenti lingue: cinese semplificato, cinese
tradizionale, giapponese e coreano.

11486 01218053 Ora puoi importare bots padri e figli con dipendenze
anche se non si hanno i permessi per tutte le cartelle.
In precedenza, se un utente senza permessi per le
cartelle importava bots padre e figlio con dipendenze,
la dipendenza tra loro veniva persa.

11486 01046249 Quando effettui la migrazione da Enterprise 11
a Automation 360, non vengono più create voci
duplicate per nessuno dei comandi esistenti.

11486 -- Ora puoi migrare con successo un Enterprise 11
bot che utilizza il comando Esegui attività anche
se l'opzione In caso di errore, continua con la
ripetizione successiva è deselezionata.
In precedenza, il bot genitore smetteva di funzionare
se il bot figlio riscontrava un errore. Ora, quando
questa opzione non è selezionata, un gestore errori
assicura che la migrazione vada a buon fine anche se
il bot figlio riscontra un errore.
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Crea ID caso Service
Cloud

Descrizione

11486 -- Se hai usato l'action Vai alla cella dal package Excel
advanced in un Enterprise 11 bot, l'impostazione è
ora mantenuta quando lo migri verso Automation
360.

11486 00779016 Ora puoi usare il XML package per aprire qualsiasi
file xml senza alcun problema dopo la migrazione a
Automation 360.

11486 00794202 Ora puoi utilizzare senza problemi il If per effettuare
la migrazione dei Enterprise 11 bots verso
Automation 360.

11486 00790245 Ora puoi usare l'action SOAP Web Service del SOAP
Web Service package senza alcun problema dopo la
migrazione a Automation 360.

11486 00795518, 00832462 Se hai usato l'action Elimina celle dal package Excel
advanced in un Enterprise 11 bot, gli indirizzi corretti
delle celle vengono ora visualizzati quando lo migri in
Automation 360.

11486 00808601 Nei bots migrati che includono le actions Estrai
e Sottostringa di String Operation non viene più
riscontrato un errore se la stringa di input è vuota.

11486 00807945, 01258127 Quando migri i Enterprise 11 bots usando il comando
Error Handling, non viene più riscontrato un errore
se il valore del percorso del file nella variabile non
presenta l'estensione file da Snapshot e Registra
nel file. Dopo la migrazione, ora il file di snapshot
salva i file con l'estensione .png e Registra nel file
con l'estensione .txt.

11486 00777395,
00807705, 00814087

Il processo di migrazione aggiunge ora l'action
Finestra > Imposta titolo per tutte le condizioni
ElseIf-window exists. Questa impostazione
permette di rendere dinamico il titolo della finestra,
senza dover acquisire nuovamente il titolo della
finestra quando cambia.

11486 00820094, 01019195 Dopo la migrazione a Automation 360 da Enterprise
11 o Enterprise 10, l'errore di snapshot Gestore
errori è ora registrato nel percorso immagine
Snapshot. Se il percorso immagine snapshot
è fornito come variabile, allora l'errore della
snapshot viene registrato nel percorso predefinito
dell'applicazione.

11486 00810389 Ora puoi migrare i bots con variabili i cui nomi
iniziano con o contengono arrayRows. Non si
verifica più un errore di esubero stack e i bots sono
migrati correttamente.
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Crea ID caso Service
Cloud

Descrizione

11486 00795347 L'action DLL Esegui ora copia correttamente i dati
da un foglio Excel a un altro anche se la DLL .Net
usa il meccanismo OLE (per esempio, gli appunti) per
copiare i dati. In precedenza, quando i dati venivano
copiati da un foglio Excel ad un altro, si verificava
un'eccezione legata al threading.

11486 00787562 Dopo la migrazione a Automation 360, un bot
grande di Enterprise 11 (con 2000 o più comandi)
no riscontra più l'errore di pre-elaborazione Code
 too Large for try statement quando il bot
è utilizzato nel Automation 360. Tuttavia, se il bot
migrato include un comando Loop o Attiva loop
con Continua o Interrompi come comando figlio,
potrebbe comunque verificarsi un errore di pre-
elaborazione quando il bot è in esecuzione.

11486 00782594, 00786968 Quando esegui la migrazione a Automation 360, un
bot Enterprise 11 con array di grandi dimensioni non
riscontra più errori heap Java. Se la dimensione totale
degli array in un bot supera il valore di soglia della
dimensione dell'array, allora le variabili dell'array
vengono migrate così come sono fino a quando non
superano il valore di soglia. Tuttavia, le rimanenti
variabili dell'array sono migrate come variabili di
tabella senza valore predefinito usando la Tabella >
databaseaction.

11486 00792346 Se il bot Enterprise 11 è stato configurato con
FTP sicuro senza Autenticazione file chiave,
il processo di migrazione configura ora in modo
adeguato il bot con il tipo di server FTP sicuro
in Automation 360. In precedenza, il processo di
migrazione configurava erroneamente il bot con il
tipo di server FTP sicuro.

11486 -- Gli utenti con il ruolo Amministratore AAE_Bot
Migration non rilevano più un problema quando
eseguono la migrazione dei bots utilizzando Bot
Migration Wizard.

11486 -- Bot Migration Wizard visualizza ora il numero corretto
di MetaBots nella schermata Seleziona i bot di cui
eseguire la migrazione.

11486 -- I bots Enterprise 11 di cui è stata eseguita la
migrazione non rilevano più un errore quando una
variabile mappata tra il bot padre e un bot figlio non
è disponibile in nessuno dei bots.

11486 00729719, 00959356 È ora possibile aggiungere o aggiornare
l'automazione SAP utilizzando l'action Acquisisci
del pacchetto Recorder quando lo scripting SAP è
disabilitato nel bot Enterprise 11.
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Crea ID caso Service
Cloud

Descrizione

11486 00639940, 00770561 Se il processo di migrazione non va a buon fine,
la schermata Tutte le migrazioni mostra ora
lo stato dell'operazione come non riuscita.
In precedenza, quando il processo di migrazione
non andava a buon fine a causa di credenziali del
dispositivo non valide, la schermata mostrava che
il processo di migrazione era in corso ma il Log di
audit mostrava lo stato corretto.

11486 00840456 Il processo di migrazione non rileva più un errore
quando migri un MetaBot che contiene una logica che
ha un carattere di spazio extra alla fine del suo nome.

11486 00786646,
00808600, 00822029

Il bot di cui si è eseguita la migrazione non rileva più
un errore quando contiene comandi che eseguono
un'azione in una finestra a comparsa di un browser.

11486 00777467 I bots di cui si è eseguita la migrazione non rilevano
più un errore quando vengono estratti in Automation
360 e contengono un'espressione non valida aggiunta
dal processo di migrazione.

11486 00786002 Ora, se sei in possesso di tutte le autorizzazioni
necessarie, puoi eliminare i file .atmx e .mbot dal
Control Room.

11486 00796725 Il Bot Scanner non rileva più un errore quando
analizza un bot in cui il titolo della finestra è
specificato utilizzando una variabile tra parentesi.

11486 00790861, 00836849 I bots Enterprise 11 o Enterprise 10 di cui è stata
eseguita la migrazione non rilevano più un errore
quando utilizzano il comando Esegui logica per
eseguire una logica MetaBot e la posizione di questa
è specificata fino alla cartella che la contiene.
Per esempio, supponiamo di avere un MetaBot
denominato Finance1 e che si voglia eseguire
la Logic1 disponibile in MetaBot nella posizione
Metabots\Logics\Finance. Specificando solo
Metabots\Logics\Finance invece del percorso
completo (Metabots\Logics\Finance\Logic1)
della logica, si verifica un errore.

11486 00804550 Ora puoi importare dei bots da un ambiente di
produzione Enterprise 11 verso un ambiente di
sviluppo Automation 360 anche se questi bots
includono l'ID dell'utente che aveva eseguito
l'estrazione del bot in Enterprise 11.

11486 -- Quando effettui la ricerca di bots che contengono i
seguenti caratteri, i bots ora vengono visualizzati nei
risultati della ricerca:
r$@1&#klu%)((}{,'!~`$^&()_-+=[]
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11486 00729393 Dopo la migrazione da Enterprise 11 a questa
versione, puoi visualizzare le sottocartelle del
bot nello spazio di lavoro Pubblico della Control
Roomnella pagina Automazione.

11486 -- Dopo la migrazione da Enterprise 11 a questa
versione, puoi effettuare l'archiviazione dei bots
nello spazio di lavoro Pubblico della Control Room
da una cartella per cui disponi dell'autorizzazione
Archivia utilizzando l'API del Repository Manager. Il
codice di risposta API non mostra più quanto segue:
"upload": falso.

11486 01032367, 01066099 È stato risolto un problema con la finestra di
avanzamento della distribuzione dei bot. In
precedenza, anche dopo che il bot aveva completato
l'esecuzione, la finestra veniva visualizzata per molto
tempo (per esempio, in alcuni casi per più di 10
secondi).

11486 00826923,
01081380, 01259907

Dopo aver effettuato la migrazione da Enterprise
11 a questa versione, puoi aggiungere elementi di
lavoro alle code utilizzando l'API del carico di lavoro
attraverso AWS Lambda. Un errore di Esubero stack
non compare più nei log Control Room.

11486 00801810 Quando si aggiorna Automation 360 On-Premises
a questa versione, i dispositivi Bot Agent
restano connessi. Gli errori di WebSocket non
sono più generati nel file C:\ProgramData
\AutomationAnywhere\BotRunner\Logs
\Node_manager.log.
In precedenza, quando si eseguiva l'aggiornamento
da Automation 360 v.19 (Build 8147) a Automation
360 v.21 (Build 9664), venivano segnalati alcuni
problemi che indicavano che i dispositivi Bot Agent
restavano disconnessi e venivano generati errori
WebSocket anche in assenza di modifiche alla
configurazione del proxy.
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11486 00831028,
00830336,
00827031,
00832413,
00833089,
00833436,
00832850,
00839997, 00849904,
00857296,
00831062,
00833436,
01140913,
01145306,
01252819,
01127960,
01256324, 01257414,
01258281, 01263606

Quando si aggiorna Control Room configurato
con Active Directory a questa versione, ora è
possibile utilizzare l'opzione di accesso con Windows
senza che venga generato il seguente errore
java.lang.NoSuchMethodError.

11486 00719407 Per le distribuzioni di On-Premises, quando si
configurano più indirizzi IP per i nodi Control
Room in un cluster, l'indirizzo IP primario viene ora
configurato automaticamente. Non è più necessario
configurare manualmente gli indirizzi IP primari nel
file cluster.properties.

11486 Quando stai installando Bot Agent, se esaurisci lo
spazio su disco e fai clic su OK nella schermata 
Spazio su disco esaurito, la procedura guidata
ti riporta alla finestra Tipo di configurazione
precedente, così da permetterti di annullare
l'installazione di Bot Agent.
In precedenza, quando si faceva clic su OK nella
finestra Spazio su disco esaurito, la procedura
guidata mostrava più finestre.

11486 -- Quando il Bot Agent non viene aggiornato
automaticamente da una versione precedente
a questa, puoi eseguire diverse operazioni
contemporaneamente, come l'esecuzione di bots,
la configurazione delle impostazioni dispositivi nel
Control Room e l'aggiornamento della Control Room.
Non è più necessario riavviare il servizio Bot Agent da
Gestione attività.

11486 00781135 Dopo aver installato il Bot Agent su un dispositivo
utente, quando riavvii il Bot Agent, la cartella
della cache globale (C:\ProgramData
\AutomationAnywhere\GlobalCache\) non
viene più eliminata.
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11486 00709309, 00766163 È ora possibile aggiornare a questa versione
la Control Room installata su Linux e il servizio
Elasticsearch ora si avvia con esito positivo.
In precedenza, l'aggiornamento non riusciva
perché il servizio non si avviava e veniva
visualizzato il seguente messaggio: Il servizio
Elasticsearch non si avvia durante il
processo di recupero del certificato.

11486 00742074 L'allocazione delle licenze per gli utenti configurati
per l'uso di dispositivi multiutente è ora rispettata per
i deployment simultanei di bot su Bot Runners non
assistiti.

11486 00822176 Sui dispositivi multiutente, è ora possibile creare una
sessione RDP che utilizza una porta personalizzata.
In precedenza, se si configurava un dispositivo
multiutente per l'utilizzo di una porta personalizzata
per le distribuzioni basate su RDP, le distribuzioni non
riuscivano.

11486 00806583, 00805381 Quando esegui deployment basati su RDP su un
dispositivo, FreeRDP non ha più esito negativo
quando si connette a un server Windows per il
rilascio delle licenze RDS per dispositivo.

11486 -- Se la distribuzione dei bots avviene utilizzando trigger
di evento e installi il Bot Agent su un dispositivo,
come utente non amministratore per te stesso o
per un utente Admin locale, il Bot Agent viene ora
aggiornato automaticamente. Il dispositivo non verrà
più visualizzato come disconnesso in Control Room.

11486 00803434 I problemi di cambiamento di comportamento del
client HTTP Jetty sui sistemi di bilanciamento del
carico con regola personalizzata per le intestazioni
dell'host per instradare una richiesta sono ora risolti.
La registrazione del dispositivo ora va a buon fine e
i numeri di porta vengono aggiunti all'host quando
vengono usate porte predefinite.

11486 00815334 Problemi di prestazioni relativi all'accesso al Control
Room e la modifica e l'esecuzione di bots nel Cloud
Control Room sono ora risolti.

11486 00543141,
00674098,
00714238,
00744991, 00750325

Con l'integrazione di Splunk e i miglioramenti syslog,
è ora possibile inoltrare i log di audit ai server Splunk
remoti e visualizzare i log di audit sulle dashboard
Splunk.
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11486 00776569 Quando un bot che si esegue rileva un errore, viene
ora mostrato un appropriato messaggio di errore di
pre-elaborazione o di runtime. In precedenza, veniva
mostrato un messaggio di errore di pre-elaborazione
o di runtime anche se il bot non conteneva un errore
o se il bot era vuoto.

11486 00781638,
00805371, 00804784

I problemi con un bot estratto e il suo clone sono
ora risolti. Quando un utente estrae un bot, apporta
modifiche e archivia un bot, il clone del bot nello
spazio di lavoro Privato di un altro utente viene ora
aggiornato con le modifiche.

11486 00784252 Se non hai i privilegi di amministratore della Control
Room e archivi i bots nello spazio di lavoro Pubblico
della Cloud Control Room nelle sottocartelle, le
cartelle dei bot non richiedono più tempo per essere
caricate nella Control Room.

11486 00786716,
00801631, 01189873

Non si verifica più un errore quando si utilizza l'action
Download nel package Browser per scaricare un file
da un URL Web. In precedenza, se l'URL Web aveva
una barra rovesciata alla fine o caratteri di spazio
all'inizio o alla fine, il bot non riusciva a scaricare il
file.

11486 00783197, 00818698,
00820666

Non si verifica più un errore quando si utilizza
l'action Assegna del package Numero per
assegnare i decimali a una variabile numerica
esistente, indipendentemente dalle impostazioni di
localizzazione del dispositivo sulla macchina.

11486 00778496 Ora puoi importare con successo l'archivio bot nello
spazio di lavoro pubblico anche se l'archivio crea una
cartella chiamata Sistema nella cartella Bot.

11486 00774026 Non si verifica più un problema quando si usa l'action
CSV/TXT >  Apri e l'actionTaskBot >  Esegui per
cercare un file o un bot con un nome che contiene
caratteri giapponesi.

11486 00761035, 00786113 Adesso puoi usare l'action Registratore >
Acquisisci per catturare un oggetto in una finestra
che ha una visualizzazione albero e recuperare
la proprietà Nome elemento di quell'oggetto
utilizzando l'action Ottieni proprietà. In
precedenza, nell'esecuzione di un bot, il registratore
acquisiva correttamente l'oggetto nella finestra, ma
non riusciva a recuperare il nome dell'elemento di
tale oggetto nell'output.

11486 00763925 Non si verifica più un errore quando si utilizza l'action
Dividi del package Stringa per dividere una stringa
sorgente che ha una qualsiasi combinazione di
caratteri Unicode.

© 2023 Automation Anywhere. All rights reserved.     327



    Automation Anywhere - Learn

Correzioni

Crea ID caso Service
Cloud

Descrizione

11486 00767074 In Internet Explorer, quando utilizzi l'action
Browser > Apri per aprire una nuova finestra
o scheda, la nuova finestra o scheda viene ora
visualizzata di fronte alle altre finestre aperte non di
amministrazione.

11486 00819664 È ora possibile creare bots utilizzando l'action SOAP
Web Service. Le chiamate XML non restituiscono
più dati corrotti quando la risposta SOAP ha un
documento XML come elemento interno.

11486 00748494,
00829735, 01018622

Non si verificano più problemi quando si distribuisce
un file bot contenente trigger di e-mail. Ora, ogni
volta che viene inviato un messaggio e-mail, il
bot viene attivato ed eseguito con successo. In
precedenza, il trigger delle e-mail funzionava solo
per la prima volta che veniva inviato un messaggio e-
mail e, per i messaggi successivi, il bot non veniva né
attivato né eseguito.

11486 -- La metrica Esecuzioni di Task Bot della pagina
dashboard Home della Control Room ora mostra
il conteggio corretto. In precedenza, la metrica
Esecuzioni di Task Bot mostrava il conteggio come
zero anche se i bots erano stati eseguiti dalla stessa
Control Room.

11486 00824309 Nell'action Esegui procedura memorizzata del
package Database, quando si fa clic su Aggiungi
parametro per fornire un parametro di input o di
output, l'etichetta per il campo tipo di parametro
viene ora visualizzata come Tipo parametro. In
precedenza, l'etichetta del campo tipo di parametro
non veniva visualizzata correttamente.

11486 00810212 Quando si utilizza l'action Esegui del package Task
Bot e si seleziona l'opzione Variabili multiple
nel campo Salva il risultato in una variabile, il
nome della variabile è ora visualizzato con i caratteri
corretti. In precedenza, il nome della variabile veniva
visualizzato in minuscolo anche se era stato creato in
maiuscolo.

11486 00796913, 00836389 È ora possibile utilizzare l'action Sposta tutti dal
package Email per spostare più messaggi e-mail da
Posta in arrivo a un'altra cartella. In precedenza,
l'action Sposta tutti non era in grado di elaborare
un gran numero di messaggi di posta elettronica a
causa dell'esaurimento dello spazio di archiviazione
sul disco.
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11486 00798673, 00815700 Non si verifica più un errore quando utilizzi l'action
DatabaseConnetti, immetti la stringa di connessione
che utilizza l'autenticazione Windows ed esegui
l'action Esegui procedura memorizzata con
un valore del parametro di input superiore a 36
caratteri. In precedenza, veniva visualizzato un errore
quando la lunghezza del valore del parametro di input
superava i 36 caratteri.

11486 00799450 Quando un foglio di calcolo Excel viene aperto
nell'editor SAP e contemporaneamente si utilizza
l'action Apri del package Excel advanced per
aprire un file Excel, non si verifica più alcun errore
quando il bot viene eseguito e il file Excel viene
aperto correttamente. In precedenza, un file Excel
aperto nell'editor SAP era considerato la finestra
predefinita e quindi quando si eseguiva un bot veniva
visualizzato un errore che indicava che il file Excel
non poteva essere aperto.

11486 00794102 Nel package REST Web Service la descrizione sotto
il campo Assegna l'output a una variabile è ora
tradotta correttamente per le seguenti lingue.
• Giapponese
• Francese
• Italiano
• Portoghese (Brasile)
• Cinese semplificato

In precedenza, la descrizione non era tradotta
correttamente per queste lingue.

11486 00788920, 00796452 Nel package Email, quando si utilizza l'action
Connetti per connettersi al server Outlook o IMAP
è ora possibile scaricare con successo l'allegato e-
mail in formato file .eml. In precedenza, se c'erano
allegati di posta elettronica nei formati di file .xlsx
e .eml, venivano scaricati solo i file .xlsx.

11486 -- Se crei una variabile Dictionary con il sottotipo Any
e selezioni Data e ora come valore predefinito,
quando fai clic sull'icona dell'ora potrai vedere i
valori del tempo visualizzati nell'elenco a discesa. In
precedenza, quando si faceva clic sull'icona dell'ora
per selezionare l'ora dall'elenco a discesa, i valori non
venivano visualizzati.
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11486 00746630 Ora puoi creare una nuova attività utilizzando Excel
advanced con Loop e selezionando l'opzione Per
ogni riga nel foglio di lavoro (Office 365 Excel)
dall'elenco Iteratore, creare una variabile tipo
Record ed eseguire il bot. Non si verifica più un
errore quando si modifica lo stesso bot e si seleziona
l'opzione Per ogni riga nel foglio di lavoro (Excel
base o Excel avanzato) dall'elenco Iteratore. In
precedenza, all'esecuzione del bot veniva visualizzato
un errore di pre-elaborazione.

11486 00762978 Se utilizzi l'action Finestre > Chiudi e selezioni
Attualmente attive come titolo della finestra per
chiudere qualsiasi finestra, quando esegui il bot, la
finestra a comparsa Chiudi finestre non viene più
attivata, anche se non ci sono finestre attive sulla
macchina.

11486 00805654 L'action Dividi del package Stringa permette ora di
selezionare l'opzione Qualsiasi per contenere i valori
di uscita. In precedenza, era possibile selezionare
solo la variabile elenco.

11486 00761189,
00764563,
00785751,
00794273, 00835194

Problemi di prestazioni relativi all'action Esegui
macro nel package Excel advanced sono ora risolti.

11486 00796120 Quando utilizzi l'action Tabella dati > Ordina per
ordinare una colonna, se la colonna non contiene
alcun valore, il bot funziona come previsto e non si
blocca. In precedenza, era necessario fermare il bot
manualmente.

11486 00830011 Nel Excel advancedpackage, quando esegui l'action
Vai alla cella vuota successiva su un foglio Excel,
il sistema non esaurisce più la memoria.

11486 00765210, 00790641 Non si verifica più un errore quando si usa l'action
Excel avanzato > Apri per aprire un file Excel che
contiene una tabella pivot.

11486 00776021 Quando utilizzi l'action Open del Excel
advancedpackage per aprire una cartella di lavoro
Excel, anche se la cartella di lavoro ha collegamenti
non validi, i bots ora funzionano come previsto.

11486 00692220,
00785965, 00798035

Problemi di prestazioni relativi all'action Scrivi da
tabella dati del package Excel advanced sono ora
risolti e l'action ora funziona meglio su fogli Excel con
grandi quantità di dati.
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11486 00808137 Il formato di Data di inizio e Data di fine sotto la
condizione Data è ora aggiornato a MM/gg/AA per
le seguenti actions dei packages File e Cartella, dove
gg ora mostra correttamente la data:
• File package

• Copia file desktop action
• Elimina action
• Stampa action
• Stampa più file action
• Rinomina action

• package cartella
• Copia action
• Elimina action
• Rinomina action

In precedenza, il formato di Data di inizio e Data
di fine era MM/GG/AA dove GG dava il conteggio
dei giorni dell'anno invece della data.

11486 -- Quando esegui un bot con la seguente sequenza di
actions, il file viene cancellato con successo alla fine
della sequenza:
1. action CSV/TXT > Apri per aprire un file .csv
2. Un'action loop all'interno di un'altra action loop

per recuperare i valori dal file .csv
3. action CSV/TXT > Chiudi per chiudere il file

In questo caso, tutte le actions utilizzano la
stessa sessione predefinita.

4. action File > Elimina per eliminare il file

In precedenza, il file non veniva eliminato, perché il
bot non riusciva a chiudere la sessione predefinita.

11486 01164436,
01209626,
00975390,
01080879,
01254846,
01256132,
01255004,
01263774,01253240

Non si verifica più un errore quando si usa la
versione 2.4.0-20211118-080716 del Recorder
package per catturare un controllo che utilizza
la tecnologia HTML nel browser Google Chrome
o Microsoft Edge Chromium ed eseguire il bot.
In precedenza, quando si utilizzava la versione
2.3.0-20210806-215200 del Recorder package, il
bot non andava a buon fine restituendo il seguente
messaggio di errore:Impossibile trovare
il controllo. Criteri di ricerca non
corrispondenti
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11486 00818990 L'opzione di ancora di cattura nel Recorder package
è ora supportata per l'applicazione Citrix XenApp. È
ora possibile selezionare un'ancora per cercare un
oggetto in un'interfaccia utente durante l'esecuzione
del bot ed eseguire azioni basate su di esso.

11486 00782962 Non si verifica più un errore quando si esegue un
loop su più fogli Excel e si usano le sequenze di tasti
all'interno del loop per copiare e incollare i valori
recuperati in un altro foglio Excel. In precedenza,
quando si aprivano e chiudevano più fogli Excel
all'interno di un loop, il bot non identificava il foglio
Excel coretto per eseguire l'action della sequenza di
tasti.

11486 -- Ora puoi usare l'action Stringa > Importa stringa
da file di testo per leggere i valori dal file di testo
durante l'esecuzione di un bot se la codifica del file
di testo è stata impostata su una delle seguenti
codifiche:
• UTF-16BE
• UTF-8
• ANSI
• Window-1251
• UTF-16LE
• Shift-JIS

11486 -- Quando si aggiorna il Control Room su Linux da
qualsiasi versione precedente a Automation 360 v.21,
il Control Room mostra ora l'interfaccia aggiornata.
In precedenza, quando si aggiornava a Automation
360 v.21, l'interfaccia del Control Room continuava
a visualizzare la vecchia interfaccia della versione
precedente.

11486 00816941 È ora possibile eseguire bots con coda basati sulla
sequenza di ordinamento selezionata per la colonna
dell'elemento di lavoro nel modello di quest'ultimo.
In precedenza, i bots erano distribuiti in base alla
sequenza secondo la quale gli elementi di lavoro
venivano inseriti nella coda.

11486 00804330, 00822092 Dopo che un bot è stato distribuito su un dispositivo
utente, la pagina Cronologia di esecuzione
(Gestisci > Programmato) mostra ora i dettagli
corretti sulla cronologia di esecuzione del bot.

11486 -- Quando si mette in pausa e si riprende l'automazione
di un carico di lavoro dopo aver utilizzato l'esecuzione
di un bot con la coda nella Control Room, le voci
di audit vengono ora acquisite nella pagina Log di
audit.
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11486 00803717 Nella pagina Cronologia attività della Control
Room, la pagina Modifica di mostra ora il nome
dell'utente (Bot Creator o Bot Runner) che ha
programmato un bot su un dispositivo utente. In
precedenza, la colonna mostrava il nome utente
dell'ultimo utente del bot.

11486 -- Quando si distribuiscono i bots del carico di
lavoro dalla Control Room è ora possibile eseguire
l'automazione del carico di lavoro con privilegi elevati
utilizzando l'opzione Esegui come amministratore.

11486 00780635, 00791587,
00795559,
00795632,
00797130,
00797113,
00791783,
00765770,
00826805, 01859661

When you update from a previous release, schedules
no longer disappear from a Control Room configured
on a single-node or multi-node environment.
Inoltre, gli orari precedentemente disattivati non
scompaiono più e si riattivano automaticamente dopo
l'aggiornamento.

11486 00974353 Ora puoi distribuire il carico di lavoro dei bots su
dispositivi Bot Runner perché i bots associati a una
coda non possono essere cancellati. In precedenza,
l'utente aveva il permesso di cancellare i bots del
carico di lavoro mentre erano in esecuzione con la
coda.

11486 00830546, 01181402 Quando vengono inseriti elementi di lavoro per le
automazioni del carico di lavoro, non si verifica più
un errore Esubero stack Apache Ignite e il server del
Control Room non smette di funzionare.

11486 01021889 Quando si pianifica o si distribuisce un bot dalla
Control Room, se un bot non riesce ad essere
eseguito, viene ora inviata una notifica via e-mail.
In precedenza, anche se l'amministratore della
Control Room abilitava l'impostazione Un Task
Bot si interrompe perché non viene eseguito
correttamente nell'impostazione della Control
Room, non veniva inviata un'e-mail di notifica.

11486 00949288 I bots programmati non sono più bloccati nello
stato di esecuzione in sospeso a intermittenza nella
pagina Attività e i successivi bots programmati per
l'esecuzione non sono bloccati in coda.

11486 01253045, 01256337 Ogni bot programmato è ora distribuito su dispositivo
Bot Runner una volta al giorno. In precedenza, alcuni
bots programmati erano distribuiti due volte su
dispositivo Bot Runner.
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11486 00750399 È ora possibile acquisire oggetti da Microsoft Internet
Explorer in esecuzione come XenApp su un server
Citrix che dispone di più applicazioni Citrix installate.

La seguente tabella elenca le limitazioni identificate nella versione attuale:

Limitazioni in questa versione

In Enterprise 11, if bots were using windows variable where the window title value did not use the
exact case as that of the application window title, after migration, the bots will fail to execute.
Soluzione: You can migrate to Automation 360 v.26 release where this issue is fixed or ensure that
you change the case of the window titles in windows variables to match the case of the window
titles and then migrate the bots.

Quando si esegue la migrazione a un bot utilizzando l'action Manage Window Controls, l'ultima
cifra del valore dell'altezza non è disponibile dopo la migrazione. Tuttavia, il bot verrà eseguito
correttamente. (ID caso Service Cloud: 01756996)

Quando una sessione di Excel è attiva in SAP, si avvia un processo Excel corrispondente in
background. In questo scenario, Automation 360 utilizza lo stesso processo Excel iniziato da SAP.
Quando si esegue un bot per automatizzare i dati del foglio di calcolo, Automation 360 elabora la
prima richiesta con successo. Tuttavia, durante l'esecuzione, se l'Excel viene chiuso e viene inviata
una successiva richiesta di automatizzazione dei dati del foglio di calcolo, Automation 360 non
elabora la richiesta perché il processo Excel è ancora in fase di accesso da parte di SAP. Pertanto,
non viene attivata la finestra corretta per automatizzare i dati del foglio di calcolo. (ID caso Service
Cloud: 00815159)

Quando esegui il bot, la metrica Esecuzioni di TaskBot nella pagina Dashboard Home  della
Control Room non mostra il conteggio corretto. Ad esempio, il conteggio delle esecuzioni di bot
delle attività mostra il valore 39 nella pagina Dashboard Home, ma quando esegui il bot, il
conteggio viene visualizzato come 42 anziché 40.

(ID caso Service Cloud: 01753337) Nella tabella "In corso" non è possibile utilizzare la funzione di
ordinamento delle colonne per elencare le voci in ordine crescente o decrescente.

Dopo la migrazione, quando esegui un bot padre-figlio che condivide una sessione e utilizzi versioni
diverse del pacchetto DLL, l'esecuzione del bot ha esito negativo con un messaggio di errore di run-
time.

• Gli iFrame nidificati non sono supportati nei browser Google Chrome e Microsoft Edge
Chromium.

• Dopo aver eseguito un'azione in un'applicazione o pagina, se un frame viene aggiunto durante il
runtime all'applicazione o alla pagina e il frame viene popolato e la pagina non viene aggiornata
o ricaricata, gli elementi nel frame dell'applicazione o nella pagina non possono essere acquisiti o
riprodotti fino a quando aggiorni manualmente quella pagina.
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(ID caso Service Cloud: 00988580, 01200161) Dopo aver migrato da Enterprise 11 a Automation
360, potresti non essere in grado di eseguire il comando Estrai su alcuni bots e dipendenze nello
spazio di lavoro Pubblico della Control Room.
Soluzione: Estrarre bots padre nello spazio di lavoro Pubblico di Control Room. Le dipendenze
vengono clonate automaticamente.
Per ulteriori informazioni, consulta Cannot Check Out With Child Dependencies Due To No Versions (A-
People login required).

Se si aggiorna direttamente da Automation 360 On-Premises v.20 o v.21 a questa versione, si
potrebbero verificare problemi nell'aggiornamento del Bot Agent su alcune macchine Bot Runner nei
seguenti scenari:
• Dopo un aggiornamento del Control Room, lo stato del dispositivo continua a cambiare e il Bot

Agent non riesce ad aggiornarsi automaticamente.
• Se il file embedded resources è mancante, il Recorder non riconosce gli elementi

dell'interfaccia utente o non cattura un singolo oggetto nel browser Google Chrome.

Soluzione: prima di aggiornare a questa versione, rimuovere i seguenti file e cartelle Bot Agent:
• C:\Windows\System32\config\systemprofile\AppData\Local

\AutomationAnywhere\AA-DB.mv.db
• C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-resources

Per ulteriori informazioni, vedi Bot agent auto update fails post the Control Room Upgrade with
'device.connection.lost' (A-People login required) | The recorder is not able to recognize the GUI elements in
Google Chrome browser (A-People login required)

In alcuni casi, se si Archivia un bot nello spazio di lavoro Pubblico della Control Room, dopo aver
filtrato una qualsiasi dipendenza, quando esporti il bot vengono visualizzate tutte le dipendenze
invece dei dati filtrati.

(ID caso Service Cloud: 00773700) Il processo di migrazione non riesce a migrare bots che
contengono più di 96 condizioni in un singolo comando If.
Soluzione: suddividi il comando If in due comandi If in Enterprise 11 ed eseguire poi la migrazione
del bot aggiornato.

If you create a bot that has invalid JSON tags with an Error Handling action (Try/Catch) in it, and if
the Bot validation service is enabled (ON) in the Settings > Bots page, when you run the bot,
the bot fails because of a preprocessing error.
Soluzione: nel menu Bot editor, apri il bot con l'errore. Seleziona e fai clic su qualsiasi linea di
codice, modificala e salvala. Per esempio, se hai creato un bot utilizzando l'action Commento,
seleziona e fai clic sull'action Commento, modificalo inserendo uno spazio nella casella del
commento e poi fai clic su Salva. Eseguendo ora il bot, non verrà più mostrato un errore di pre-
elaborazione.

In SOAP Web Service, non è possibile selezionare il parametro Dati non elaborati e utilizzare
l'opzione Crea Xpath per estrarre i valori dalla risposta SOAP e memorizzare l'output XML.
Soluzione: inserisci l'espressione Xpath manualmente invece di usare l'opzione Crea Xpath nella
risposta selezionata.
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Quando cerchi di stabilire una connessione sicura SQL nell'ambiente Linux scegliendo l'opzione
Abilita nel campo Configurazione database >  Connessione sicura, il programma di
installazione di Linux non riesce a importare il certificato SSL e la connessione ha esito negativo.
Soluzione: seleziona l'opzione Disabilita nel campo Configurazione database > Connessione
sicura. Il programma di installazione di Linux stabilisce con successo una connessione sicura al
database SQL.

In ambiente Linux, la funzionalità di caricamento dei file di AARI on the web ha esito negativo con
un errore di accesso negato. Questo errore si verifica perché la directory filestorage non viene
creata automaticamente per memorizzare i file.
Soluzione: crea la directory filestorage nel percorso del nel percorso dell'archivio Automation 360
e assegna i permessi appropriati come indicato nei passaggi seguenti:
1. Accedi al percorso dell'archivio di Automation 360: /opt/automationanywhere/

automation360/appdata/Server Files

2. Inserisci i seguenti comandi nella console di Linux:
a. sudo mkdir storageservice

b. sudo chown -R crkernel:controlroom storageservice

c. sudo chmod -R 775 storageservice

Quando si aggiorna la Control Room dalla versione precedente, la metrica Esecuzioni di Task Bot
sulla dashboard Home non visualizza il conteggio storico dei task bot che sono stati eseguiti nella
versione precedente. Mostra solo il conteggio dei task bot eseguiti dalla Control Room aggiornata.

Quando utilizzi il Recorder per acquisire oggetti su applicazioni in esecuzione su Microsoft Edge
Chromium con modalità Internet Explorer, utilizza le condizioni Recorder nel bot per controllare se
l'elemento esiste nell'applicazione, prova ad acquisire gli elementi UI nell'applicazione in base al
risultato della condizione ed esegui il bot, così il bot passerà sempre alla prossima action, poiché la
condizione Recorder non sarà in grado di individuare l'elemento UI nell'applicazione.
Soluzione: usa invece Image Recognition per individuare un elemento UI in un'applicazione.

La copia delle variabili tra bots utilizzando l'opzione Copia negli appunti condivisi non è
supportata.

La seguente tabella elenca le limitazioni delle versioni precedenti applicabili anche a questa versione:

Limitazioni rispetto alle versioni precedenti

Se configuri un archivio chiave esterno in Integrazione dell'archivio chiave esterno e selezioni
la modalità Autenticazione SQL per l'autenticazione del database nella pagina del programma
di installazione di Windows Server di database per installare la Control Room (On-Premises),
l'installazione ha esito negativo e viene mostrato il seguente messaggio di errore: Impossibile
creare le tabelle del database della Control Room.
Soluzione: aggiungi le credenziali del database nell'archivio chiave esterno e utilizza queste
credenziali per la configurazione del database.
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Limitazioni rispetto alle versioni precedenti

Gli utenti della Control Room appena creati su Windows per VM On-Premises Google Cloud Platform
non possono modificare la propria password. L'opzione delle domande di sicurezza non è disponibile
nella schermata Cambia password e, di conseguenza, la Control Room visualizza un errore
quando si tenta di salvare la password.
Soluzione: aggiornare la pagina e modifica nuovamente la password.

(ID caso Service Cloud: 00837271) Se si sta migrando da Enterprise 11 con un database che ha
una grande quantità di dati d'archivio, l'installazione potrebbe non riuscire. Questo problema si
verifica perché l'aggiornamento di Liquibase per alcune query SQL non viene completato durante la
migrazione.
Soluzione: contatta l'assistenza Automation Anywhere.

Correzioni per la sicurezza

ID caso Service Cloud Descrizione

00836486, 00942844,
01264029

Modulo disabilitato per la memorizzazione nella cache che utilizzava
l'autenticazione delle credenziali.

AARI (Automation Anywhere Robotic Interface)

Novità

Nuovo filtro di query nelle azioni Richieste di query e Attività query
Utilizza il nuovo filtro ora disponibile nelle actions Richieste di query e Attività query del
package Web AARI per filtrare le richieste e le attività di query per nome del team nell'interfaccia
Web AARI.

Filtro Nome del team
Puoi filtrare le attività e le richieste per nome del team rispettivamente nelle pagine Attività e
Richiesta nell'interfaccia Web. Seleziona l'etichetta Team dal filtro e ricerca per nome del team
per visualizzare i team assegnati a un'attività o a una richiesta.
Filter and search for a request alla pagina 2168 | Filtrare e cercare un'attività alla pagina 2170

Supporto per log di audit (ID del caso Service Cloud: 00801166)
Ora è possibile visualizzare i log di audit e fare riferimento agli eventi relativi a richieste, team,
pianificatore, configurazione del processo, impostazioni bot, attività umane e attività bot create,
eliminate, aggiornate, inviate o recuperate.
Log di audit alla pagina 2654
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Miglioramento dell'assegnazione delle attività all'utente in Attività umana
Nell'editor di processo, l'opzione Assegna automaticamente quest'attività in Attività umana
offre le seguenti alternative:
• L'utente che ha creato la richiesta: L'attività viene automaticamente assegnata all'utente

che crea questa richiesta nell'interfaccia Web.
• L'utente che apre quest'attività: L'attività viene assegnata automaticamente all'utente che

apre l'attività nell'interfaccia Web.

Questa funzionalità aiuta a ridurre i conflitti nell'assegnazione di un'attività a se stessi, in particolare
nel caso di utenti specializzati come Validator per i quali l'azione di aprire un'attività equivale ad
assegnare l'attività a se stessi.

Miglioramento della configurazione del team
È ora possibile aggiungere contemporaneamente più utenti con ruoli simili (ruolo personalizzato)
al team AARI nell'interfaccia Web. Il ruolo personalizzato nella Control Room è ora allineato con un
team nell'interfaccia Web AARI e la configurazione migliorata del team funziona come segue:
• Agli utenti aggiunti con il ruolo viene assegnato un ruolo Membro nel team. Il ruolo non può

essere cambiato in Proprietario o Admin.
• Non è possibile visualizzare questi utenti nella scheda Utenti della pagina Team.
• Se un utente è sia parte di un ruolo che aggiunto manualmente al team, il suo ruolo nel team

sarà lo stesso assegnatogli manualmente. Per esempio, se un utente è un membro, continuerà
ad avere il ruolo Membro mentre se l'utente è un proprietario, gli verrà assegnato il ruolo
Proprietario nel team.

• Se l'utente non fa più parte di un ruolo, non farà più nemmeno parte del team.

Inoltre, la pagina Team è ora migliorata con opzioni di navigazione nella parte superiore che
consentono di navigare attraverso le varie schede (Generale, Utenti, Ruoli, Processi e Bot).
Utilizza le schede Generale, Utenti e Ruoli per creare team e aggiungervi utenti. Le schede
Processi e Bot visualizzano rispettivamente i processi e i bots assegnati ai team.
Team management alla pagina 2157 | Creare un team AARI e assegnare i ruoli ai membri alla pagina
2164

Supporto per la configurazione dei bot
L'amministratore AARI può utilizzare la pagina Configurazione bot per visualizzare i bots
assegnati a un team, assegnare i team a un bot e modificare i bots per rimuovere o riassegnare
i team. I Bot Runners assistiti che possono visualizzare tutti i bots archiviati nello spazio di lavoro
Pubblico possono ora visualizzare i bots assegnati ai team in AARI Assistant.
Bot setup alla pagina 2178

Miglioramenti al logo del modulo
Ora puoi utilizzare il campo Logo nel piè di pagina per selezionare fino a due logo indipendenti
che vengono visualizzati nel piè di pagina del modulo durante il runtime del bot.
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Aggiunta di regole a vari elementi del modulo
Quando si crea o si modifica un modulo nel creatore di moduli, è ora possibile aggiungere regole ai
seguenti elementi del modulo utilizzando la scheda Regole del modulo:
• Checkbox
• Data
• Documento
• Elenco a discesa
• Etichetta
• Numero
• Password
• Pulsante di opzione
• Rich Text Editor
• Area testo
• Casella di testo
• Ora

Per gli elementi Checkbox e Pulsante di opzione, le regole sono attivate solo se le
corrispondenti impostazioni predefinite sono selezionate. Ad esempio, se un modulo ha due opzioni
che si escludono a vicenda, come Sì e No, le regole associate a queste opzioni vengono attivate
solo quando si seleziona una delle due opzioni.
Aggiunta di regole agli elementi di un modulo alla pagina 2202
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Aggiornamenti ai trigger
Per eseguire un bot sono ora disponibili i seguenti trigger:
• Trigger di processo: Avvia un bot quando lo stato del processo specificato in Microsoft

Windows soddisfa una delle seguenti condizioni predefinite:
• Avvia
• Sospendi

Aggiunta di un trigger di processo alla pagina 2214
• Trigger di servizio: Avvia un bot quando lo stato del servizio specificato in Microsoft Windows

soddisfa una delle seguenti condizioni predefinite:
• Avvia
• Sospendi
• Riprendi
• Metti in pausa
• In esecuzione
• È stato sospeso
• È in pausa

Aggiunta di un trigger di servizio alla pagina 2214
• Trigger di finestre: Avvia un bot quando la finestra dell'applicazione specificata soddisfa una

delle seguenti condizioni predefinite:
• Apri
• Chiudi

Aggiunta di un trigger di finestra alla pagina 2215

Cosa è cambiato

Miglioramento al package Crea una richiesta
Nel package Crea una richiesta, è ora possibile sfogliare e scegliere il processo pubblico per il
quale si desidera creare una richiesta. Con questo miglioramento, è possibile scegliere il processo
pubblico senza dover contattare l'amministratore AARI per l'URI del processo pubblico e inserire
l'URI manualmente. Questa caratteristica semplifica anche gli input del processo di mapping per i
campi iniziali del modulo.
AARI Web package alla pagina 1369

Correzioni

ID caso Service Cloud Descrizione

00800192 Ora è possibile utilizzare il trigger di e-mail per avviare un bot senza
alcun problema, anche quando il server e-mail è POP3.

00801428 Ora è possibile aggiungere un trigger di e-mail a un account Gmail
per avviare un bot per ogni nuova e-mail.
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Correzioni

ID caso Service Cloud Descrizione

00736309, 00765069,
00784362

Per i documenti nel formato .csv, .xlsx o .xls, è possibile
utilizzare un trigger di file per avviare un bot quando un documento
viene modificato.

00796697 Quando si archivia un bot, il trigger dell'evento privato associato viene
ora mantenuto.

00802427 Con la licenza Bot Creator, ora puoi visualizzare tutte le richieste e le
attività indipendentemente dal tuo ruolo o da altre licenze che ti sono
state assegnate.

00829282 Quando si crea una richiesta nell'interfaccia web, il bot ora funziona
correttamente e non incontra alcun problema di elaborazione,
come uno stato di inattività che impedisce l'avanzamento del bot in
questione.

-- Quando più di quattro elementi delle caselle di testo di un modulo
sono popolati in un processo, il documento viene ora visualizzato
correttamente nel visualizzatore di documenti indipendentemente
dallo stato degli elementi delle caselle di testo. In precedenza, il
documento non veniva visualizzato.

-- Quando elimini una richiesta dalla scheda Richiesta e questa viene
inviata al cestino, l'attività correlata dalla scheda Attività viene
rimossa.

-- Quando utilizzi le condizioni di tipo Data e Booleana If/Else, ora
c'è parità nella convalida delle condizioni tra un bot e un processo.
Inoltre, la condizione di tipo Stringa If/Else ora permette ai valori
di destinazione di essere vuoti. In precedenza, la convalida per le
condizioni di tipo Data e Booleana non era supportata quando
veniva usata in un processo e i valori di destinazione non potevano
essere vuoti.

-- I problemi con l'elemento Collegamento ipertestuale in Attività
umana sono stati risolti. L'elemento Collegamento ipertestuale
ora funziona correttamente con i seguenti comportamenti:
• Se l'URL del collegamento ipertestuale è vuoto, al momento

della progettazione o quando viene passato dal processo, il
collegamento ipertestuale non è disponibile. In precedenza, il
collegamento ipertestuale era impostato sul dominio Control
Room.

• Se il Collegamento ipertestuale è usato in un'Attività umana
di sola lettura, i dati vengono ora passati dall'editor del processo
al modulo. In precedenza, i dati dell'editor di processo venivano
ignorati.

-- Per l'elemento Tempo nei moduli, quando sono selezionate le opzioni
Usa l'ora locale quando il modulo viene visualizzato per la
prima volta e Rendi il campo obbligatorio, l'ora di sistema viene
considerata come valore predefinito e può essere modificata nel
modulo iniziale.

La seguente tabella elenca le limitazioni identificate nella versione attuale:
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Nell'interfaccia Web mancano l'azione Imposta avvertenza e l'azione Imposta errore per gli
elementi Casella di controllo, Elenco a discesa, Pulsante di opzione e Rich Text Editor.

Per gli elementi Data e Ora, quando la data e l'ora sono incluse in una regola, qualsiasi modifica
al formato della regola non si riflette nella sezione delle regole. Di conseguenza, quando cerchi di
elaborare una regola che contiene quella data e ora, l'esecuzione del bot ha esito negativo.
Soluzione: apri l'editor delle regole ed espandi le regole corrispondenti per selezionare dal
calendario un valore di dati corrispondente prima di salvare. Non cambiare il formato dopo che
l'elemento data e ora è stato incluso come parte di una regola. Puoi anche eliminare gli elementi
data e ora più vecchi.

Quando usi l'elemento Seleziona file nei moduli e selezioni l'opzione Rendi il campo non
modificabile, l'elemento può ancora essere modificato.

Quando esegui un bot utilizzando il comando Membri del team dal pacchetto Web AARI, verrà
visualizzato un errore di eccezione.

In AARI sull'interfaccia web, se si crea una variabile usando il tipo Modulo in un bot, non è
possibile copiare quella variabile in un altro bot anche quando selezioni l'opzione Mantieni o
Sovrascrivi.

Quando un utente è membro di un team per ruolo (è stato aggiunto a un ruolo in Control Room e
in seguito il ruolo è stato sincronizzato con il team), non potrà visualizzare informazioni aggiornate
sui dettagli della richiesta o dell'attività nell'interfaccia utente. Ciò è dovuto al fatto che la pagina
Richiesta non si aggiorna automaticamente.
Soluzione: aggiorna la pagina Richiesta per visualizzare i dettagli aggiornati della richiesta o
dell'attività.

La seguente tabella elenca le limitazioni delle versioni precedenti applicabili anche a questa versione:

Limitazioni rispetto alle versioni precedenti

In una configurazione SDS, quando si crea una richiesta di caricamento di un file, il caricamento
non riesce e viene visualizzato un messaggio di errore relativo a una Eccezione di token di
sicurezza non valido.

Discovery Bot

Novità

Installare Bot Agent senza problemi
Se Bot Agent non è ancora stato installato, verrà ora richiesto di installare Bot Agent dalla scheda
Processi. Segui le istruzioni sullo schermo per installare il Bot Agent. Dopo l'installazione, viene
richiesto di abilitare un plug-in di Chrome per procedere con le attività di registrazione.
Prerequisiti per Discovery Bot alla pagina 2335
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Miglioramento delle opportunità generate automaticamente
È ora possibile iniziare a rivedere un'opportunità generata automaticamente dalla scheda
Opportunità quando almeno una registrazione di processo viene presa in considerazione per
l'esame. Esamina l'opportunità generata automaticamente e scegli di creare un'opportunità
personalizzata da un'opportunità generata automaticamente, come richiesto.
Esame delle opportunità, conversione in bot e creazione di PDD alla pagina 2355

Nuove registrazioni da esaminare per opportunità personalizzate
È ora possibile esaminare le nuove registrazioni inviate da un utente Discovery Bot per
un'opportunità personalizzata. È possibile scegliere di accettare o rifiutare gli aggiornamenti della
registrazione come parte del flusso di lavoro dell'opportunità personalizzata. Questa opzione
permette di esaminare rapidamente e facilmente le nuove registrazioni in tempo reale, mentre
queste vengono inviate dall'utente per tale processo.
Esame delle opportunità, conversione in bot e creazione di PDD alla pagina 2355

Miglioramenti alla pagina Opportunità
La pagina delle opportunità è ora aggiornata per includere una mappa dell'evoluzione delle
opportunità, insieme ad altri grafici, per aiutare a rivedere e analizzare i dati per una potenziale
opportunità di automazione. Utilizza la mappa dell'evoluzione delle opportunità per scegliere quali
opportunità automatizzare per prime.
Analisi delle opportunità di automazione alla pagina 2354

Scarica il documento PDD dalla pagina Registrazioni
È ora possibile scaricare ed esportare un documento PDD dalla pagina Registrazioni. Dopo
l'invio di una registrazione per la revisione da parte di un analista, il PDD inizia automaticamente
l'elaborazione in background. Quando il PDD viene generato, il campo cambia da Elaborazione
PDD in corso a Scarica. È ora possibile scegliere di scaricare il documento in formato Word, PDF
o entrambi. Viene anche inviata una notifica via e-mail all'utente aziendale all'indirizzo e-mail
in archivio. Scarica PDD come documento Word o PDF è disponibile anche per un'opportunità
personalizzata dalla tabella Elenco delle opportunità.
Esame delle opportunità, conversione in bot e creazione di PDD alla pagina 2355

Correzioni

ID caso Service Cloud Descrizione

-- Ora riceverai una notifica via e-mail per un PDD generato in
Automation 360 v.21. In precedenza, quando si aggiornava a
Automation 360 v.22, a volte si ricevevano più notifiche via e-mail sul
PDD generato in Automation 360 v.21.

La seguente tabella elenca le limitazioni identificate nella versione attuale:
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Durante l'aggiornamento, i documenti PDD relativi alle registrazioni e alle opportunità
saltuariamente non vengono generati.
Soluzione: modificare il diagramma di flusso per l'opportunità personalizzata che ha mostrato un
errore e salvare. In alternativa, è possibile creare una nuova opportunità da quella esistente.

A seconda della memoria disponibile nel sistema, il documento PDD (in formato PDF o Microsoft
Word) può supportare fino a 250 passaggi registrati acquisiti nel documento. Se un processo viene
registrato con più di 250 passaggi, la generazione di PDD smette periodicamente di funzionare.
Soluzione: rigenera il PDD e fai clic su Scarica.

Il documento PDF PDD per gli utenti aziendali e gli analisti non visualizza i caratteri Unicode quando
inseriti nei campi Nome opportunità e Descrizione passaggio.

Utenti cloud: per un'opportunità generata automaticamente o personalizzata, viene visualizzato a
intermittenza un errore dalla tabella Registrazioni.
Soluzione: ricarica la pagina per aggiornare la tabella Registrazioni.

Dopo aver salvato le modifiche, se aggiorni un flusso di lavoro di processo aggiungendo o
rimuovendo dei passi, i valori della finestra Panoramica potrebbero non essere aggiornati per
includere le modifiche recenti.
Soluzione: ricarica la pagina per aggiornare e includere le recenti modifiche apportate ai valori
dell'opportunità nel riquadro Panoramica.

Utenti cloud: la creazione di un'opportunità personalizzata con più di 250 passi non è supportata.

Utenti Linux: La sezione del diagramma di flusso della registrazione non viene visualizzata nel
PDD.

Per distribuzioni On-Premises, quando un certificato autofirmato o jolly viene usato per la
configurazione della Control Room, la pagina Processi non viene caricata.
Soluzione: aggiorna o aggiungi il certificato Control Room al Java Credential Store su tutte le
macchine Bot Runner affinché la pagina Processi venga caricata.
Add Control Room certificate to Windows certificate stores alla pagina 993

Per le opportunità e le registrazioni personalizzate, c'è un problema intermittente e un errore
che genera un messaggio PDD. Non sarà possibile accedere e scaricare un PDD e sarà invece
visualizzato un messaggio di errore Errore durante la generazione del PDD.
Soluzione: Solo per le opportunità personalizzate, puoi creare una nuova opportunità nel tuo
flusso di lavoro usando l'opzione Salva con nome OPPURE modificare il grafico del tuo flusso
di lavoro con ogni piccolo cambiamento apportato e salvarlo. Fatto ciò, la generazione di PDD
funzionerà correttamente.

Discovery Bot supports bot conversion to template only. To generate the automation task, you must
manually update or enhance the template generated by Discovery Bot in the RPA workspace. (ID
caso Service Cloud: 01840856, 01822803, 01860950)
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Feature deprecation for Discovery Bot

Review the deprecated feature to understand how it can impact your automation.

Discovery Bot Aggregated and Comparison options
The Discovery Bot Aggregated and Comparison tabs from the Processes page has been deprecated
as of June 2021. You can use the Opportunities tab to view processes in an aggregated workflow.

IQ Bot

Novità

Document Automation rilasciato in Community Edition
Community Edition offre ora funzionalità limitate dalla versione di Document Automation. Questa
versione è integrata in Community Control Room. Quando si crea un'istanza di apprendimento, IQ
Bot crea automaticamente bots RPA per estrarre e scaricare i dati e un processo AARI per gestire il
processo dall'inizio alla fine. La convalida avviene ora nelle attività AARI.
Utilizza Community Edition IQ Bot per estrarre i dati dalle fatture in inglese.
Community Edition alla pagina 2467

Miglioramenti dei moduli standard IQ Bot
IQ Bot offre ora i seguenti miglioramenti relativi ai moduli standard:
• È ora possibile estrarre i dati dalle tabelle.
• È ora possibile utilizzare la distribuzione dei container.

Using IQ Bot for standard forms alla pagina 2538

Supporto CyberArk
Il processo di installazione di On-Premises permette ora agli utenti di connettersi a CyberArk per
memorizzare le loro chiavi personalizzate per criptare e decriptare i dati di IQ Bot.

Nota:  Questa funzionalità è disponibile solo per le nuove installazioni.

Installazione di IQ Bot in modalità Personalizzazione alla pagina 1079

Miglioramenti del classificatore
È ora possibile creare gruppi di documenti personalizzati in un'istanza di apprendimento. Questo
riduce la possibilità che un OCR non riesca a rilevare i campi in un documento, il che farà sì che il
classificatore crei un gruppo di documenti inutilmente o invii il documento a un gruppo sbagliato.
Informazioni sul Classificatore alla pagina 2484

Visualizzazione del numero di pagine acquistate e caricate
Il dashboard IQ Bot mostra ora il numero di pagine acquistate e caricate nel periodo di licenza
corrente.
Revisione del dashboard alla pagina 2533
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Cosa è cambiato

(ID caso Service Cloud: 00656822) l'integrazione di Credential Vault è ora disponibile per le
password in IQ Bot.

Correzioni

ID caso Service Cloud Descrizione

00727633 Quando si importano o si esportano istanze di apprendimento, non ci
sono più voci di classificazione duplicate.

00768600, 00783773,
00815546, 00795424 ,
00788180

Quando si importa un file archivio (IQBA) IQ Bot esistente, è ora
possibile utilizzare l'opzione Sovrascrivi senza alcun problema.

00770638, 00746545,
00827208, 00746545,
00827208

Quando si importa il file archivio (IQBA) IQ Bot, non vedrai più voci di
gruppo duplicate.

00773631 (On-Premises) Dopo l'installazione, riavvia i servizi di IQ Bot usando
un diverso utente di Windows. Prima di questa versione, i servizi di
IQ Bot non potevano essere eseguiti con un account diverso dopo
l'installazione, determinando un percorso file incompatibile per i set di
modifiche di Liquibase.

-- Adesso puoi accedere a IQ Bot > Esplora IQ Bot con un'esperienza
utente affinata. In precedenza, un utente non poteva tornare indietro
alla pagina di destinazione della Control Room. Gli utenti possono
ora accedere alla pagina di destinazione facendo clic sul pulsante
Indietro.

00766454 Gestisci i tuoi IQ Bot non mostra più la UI errata per i bot formati
attualmente in produzione. In precedenza, mostrava un link per
creare un bot.

00804476 Quando si aggiorna il rapporto di classificazione, è ora possibile
classificare correttamente i documenti in IQ Bot. In precedenza,
poiché il nome del campo del rapporto di classificazione era più lungo
di 75 caratteri, la classificazione del documento non veniva eseguita
correttamente.

-- Nella pagina di riepilogo Istanza di apprendimento, il numero di
documenti non classificati e il numero di documenti caricati vengono
ora visualizzati accuratamente.

00695159 Un'eccezione interna nel modulo RemoveLines che causava la
mancata elaborazione dei documenti è stata risolta, e i documenti
non rimangono più in stato non elaborato a causa di questo errore.

00806557 Ora puoi assegnare correttamente un gruppo a un bot e spostare il
bot in produzione. In precedenza, in alcuni casi, l'IQBA conteneva più
bots per lo stesso gruppo, rendendo lo stato del bot incoerente.

- Ora puoi scaricare i file di output senza problemi, anche se durante il
download vengono inviate frequentemente richieste API al database
per qualsiasi istanza standard di apprendimento dei moduli.
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Correzioni

ID caso Service Cloud Descrizione

- Ora puoi usare l'action IQ Bot Extraction senza alcun problema anche
se hai selezionato l'opzione Solo per me durante l'installazione del
Bot Agent.

-- Per bots associati alle istanze di apprendimento dei moduli standard,
ora puoi caricare correttamente un numero elevato di documenti.

00776423, 00829915,
00949561

Ora puoi usare una porta personalizzata (oltre alla porta 1433) per
eseguire lo strumento Migration Assistant sul server di database.

-- Quando i documenti con nomi di file non inglesi (per esempio,
giapponesi) molto lunghi non vanno a buon fine, il problema viene
ora registrato nel file bot_launcher.log.

00814577, 00812300,
00823120

Un errore inaspettato che si verificava a causa di lunghe code di
messaggi RabbitMQ senza nome è stato risolto e l'utente può ora
navigare alla pagina Istanze di apprendimento.

-- Il servizio MLScheduler è ora disabilitato su IQ Bot Cloud e il
sistema non rallenta più o non smette di rispondere. In precedenza,
le funzioni di autocorrezione e autosuggerimento, che fanno parte
del servizio MLScheduler, utilizzavano molte risorse di sistema e
causavano il rallentamento o l'interruzione della risposta del sistema.

-- L'action Elabora documento nel package IQ Bot Extraction recupera
ora le impostazioni di pre-elaborazione di ABBYY dal server IQ Bot e
le applica al lato classico dell'elaborazione durante il runtime del bot.

La seguente tabella elenca le limitazioni identificate nella versione attuale:

Limitazioni in questa versione

Quando un bot viene spostato in produzione, i documenti diventano non disponibili nella cartella di
output del validatore o viene visualizzato il seguente errore: Progetto non trovato/Nessun
documento trovato.

Soluzione: assicurati che la lunghezza del nome del file non superi i 100 caratteri.

A volte, in una configurazione cluster un documento specifico in produzione diventa non disponibile.
Inoltre, viene visualizzato un riepilogo errato dell'istanza di apprendimento.
Soluzione: carica di nuovo e rielabora i documenti che non sono stati elaborati con successo.

Nel Designer, alcuni documenti per il gruppo creato dall'utente e i loro risultati di estrazione non
vengono caricati.
Soluzione:
1. ricarica il Designer.
2. Per ottenere dettagli di estrazione su On-Premises, vai al file Settings.txt e aumenta il

valore di Vedi timeout estrazione.

Nella pagina dei dettagli dell'istanza di apprendimento, a causa del limite di 150 caratteri, le
etichette dei gruppi creati dall'utente non vengono visualizzate in modo completo.
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Limitazioni in questa versione

Quando crei un utente amministratore di IQ Bot, se non includi il ruolo AAE_Basic insieme al ruolo
AAE_IQ Bot Admin, l'utente amministratore non può aggiungere un nuovo gruppo a un'istanza di
apprendimento.
Soluzione: assicurati di includere il ruolo AAE_Basic insieme al ruolo AAE_IQ Bot Admin nella
Control Room.

Per un'istanza di apprendimento di moduli standard, se carichi un documento che contiene una
tabella con un campo non valido, il documento viene ora inviato nella cartella Non riuscito.

Per l'azione Concatena immagini del pacchetto IQ Bot Pre-processor, non viene generato alcun
output se il nome del file contiene più di 256 caratteri.
Soluzione: Utilizza i caratteri e le convenzioni numeriche della lingua inglese.

Quando utilizzi il pacchetto IQ Bot Extraction insieme ad altri comandi basati su OCR (come ad
esempio IQ Bot Pre-processor, IQ Bot Classifier, AISense Recorder e OCR) in un singolo bot, il bot
ha esito negativo.
Soluzione: assicurati di aver creato bots separati per IQ Bot Extraction e non eseguire IQ Bot
Extraction insieme ad altri packages che includono l'OCR Abbyy 12.2.

Da un'istanza di apprendimento del tipo di dominio personalizzato con gruppi manuali, quando
esporti il file IQBA in un'altra istanza, l'Etichetta del gruppo manuale non viene esportata. Senza
un'etichetta del gruppo manuale, è difficile distinguere tra gruppi generati dal sistema e gruppi
manuali nelle nuove istanze di apprendimento.

La seguente tabella elenca le limitazioni delle versioni precedenti applicabili anche a questa versione:

Limitazioni rispetto alle versioni precedenti

Se disponi di un documento con un numero elevato di pagine (> 100), viene visualizzato un
messaggio di errore a intermittenza quando si fa clic su Guarda i risultati dell'estrazione per
un'istanza di apprendimento esistente.

Bot Insight

Cosa è cambiato

Per cambiare la lingua in Bot Insight, devi applicare le impostazioni relative alla lingua dal browser o
dal sistema operativo configurato per la lingua scelta.
Internazionalizzazione, localizzazione e supporto linguistico alla pagina 870

Correzioni

ID caso Service Cloud Descrizione

00799262, 00826862 Non si verifica più un errore quando viene eseguito un bot che include
caratteri speciali nel nome e nel comando Analizza. In precedenza,
in un bots che includeva il carattere speciale "e commerciale" (&) nel
nome e il comando Analizza si riscontrava un errore.
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Correzioni

ID caso Service Cloud Descrizione

Il calcolo nella dashboard del dispositivo è stato corretto per mostrare
una precisione massima del 100% per l'utilizzo giornaliero. In
precedenza, un errore di calcolo faceva sì che la dashboard del
dispositivo mostrasse un utilizzo giornaliero superiore al 100%.

La seguente tabella elenca le limitazioni identificate nella versione attuale:

Limitazioni in questa versione

Bot Insight non è compatibile con Microsoft Internet Explorer 11. Per un elenco dei browser
alternativi, consulta Requisiti del browser per RPA Workspace alla pagina 866.

Importante:  Per informazioni sui pacchetti supportati da questa versione, vedi View package versions
available in the Control Room alla pagina 2009.

Note sulla versione Automation 360 v.22
Data di rilascio:21 settembre 2021

Riesaminate le novità e le modifiche apportate e le correzioni e le limitazioni della Automation 360 versione
v.22. Build 10535 è per Cloud e Build 10526 è per On-Premises. For Automation 360 IQ Bot, Cloud is on
Build 10535 and On-Premises is on Build 10520.

Importante:  We have updated the Automation 360 Cloud build to include additional fixes for the Apache
Log4j2 component vulnerability. The build includes the new Log4j2 library version 2.16.0.

• Migrazione
11.x e 10.x | solo 11.x

• RPA Workspace
Novità | Cosa è cambiato | Correzioni | Limiti

• AARI
Novità | Cosa è cambiato | Correzioni | Limiti

• Discovery Bot
Novità | Correzioni | Limiti

• IQ Bot
Novità | Cosa è cambiato | Cosa è obsoleto | Correzioni | Limitazioni

• Bot Insight
Fixes | Limitations

Aggiornamento a questa versione
È possibile eseguire l'aggiornamento alla versione v.22 di Automation 360 dalle tre precedenti versioni
(ovvero dalle versioni n-3, dove n si riferisce alla versione più recente).

© 2023 Automation Anywhere. All rights reserved.     349



    Automation Anywhere - Learn

Le seguenti versioni precedenti sono certificate per l'aggiornamento a questa versione:
• v.21 (Build 9664, 9642, 9595)
• v.20 (Build 8815)
• v.19 (Build 8147, 8145, 8122, 8098)

È possibile aggiornare direttamente alla v.22 da una qualsiasi di queste build. Per i dettagli su come
eseguire l'aggiornamento, consultare Aggiornamento alla versione di Automation 360 più recente alla pagina
1063.

Recommendation:  Se non si utilizza una versione n−3 di Automation 360, eseguire l'aggiornamento a
una delle tre versioni certificate prima di eseguire l'aggiornamento a questa versione.

Importante:  This release includes a required update to your . Ensure that you complete the update to
continue with your automation activities when upgrading from a previous release to this release.
Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina
1043

To verify which  version is compatible with this release, see Compatibility with release builds alla pagina
1026.
Per informazioni sugli aggiornamenti più recenti delle estensioni di Automation 360 per Google Chrome,
Microsoft Edge e Mozilla Firefox, consultare Browser extensions for Automation 360 alla pagina 718.

Funzionalità di migrazione

Enterprise 11 e Enterprise 10 funzionalità

Eseguire la migrazione di bots che utilizzano variabili di credenziale (ID caso Service
Cloud: 00705937, 00761271, 00776189)
È ora possibile eseguire la migrazione dei bots che utilizzano variabili di credenziale non disponibili
nella Cloud Control Room. Tuttavia, è necessario creare le credenziali richieste dopo la migrazione
nell'Credential Vault e utilizzarle nei bots migrati per eseguire correttamente tali bots.

Supporto della migrazione per browser, Java e le applicazioni dell'applet Java per il
comando App Integration
È ora possibile eseguire la migrazione dei bots che contengono il comando App Integration con tipi
di applicazione quali browser, applet Java e applicazioni Java.

Nuova scheda Azione richiesta nel report Bot Scanner
Nel report Bot Scanner, è stata introdotta la scheda Azione richiesta all'interno della sezione
Bot che possono essere migrati ora per fornire una notifica anticipata sui bots per cui è
necessario un intervento manuale dopo la migrazione in modo che possano essere eseguiti
correttamente in Automation 360. Visualizzare i messaggi associati al bot per cui è necessaria
un'azione per comprendere la causa e l'azione specifica da eseguire in Automation 360.
Analisi del report di Bot Scanner per la migrazione alla pagina 1162
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Enterprise 11 e Enterprise 10 funzionalità

Azione richiesta, Revisione richiesta e Messaggi di errore per la migrazione
I messaggi di migrazione sono ora classificati nelle seguenti categorie: Azione richiesta, Revisione
richiesta e Messaggi di errore:
• I messaggi di Azione richiesta e Revisione richiesta vengono visualizzati per i bots che

contengono comandi non supportati, ma che è comunque possibile migrare ed eseguire dopo la
migrazione eseguendo azioni specifiche. I messaggi forniscono le azioni specifiche da eseguire o
le informazioni da esaminare per garantire che tali bots vengano eseguiti correttamente dopo la
migrazione a Automation 360.

• I messaggi di errore vengono visualizzati quando la migrazione di un bot specifico non viene
eseguita correttamente. I messaggi includono anche la causa dell'errore.

Messaggi di migrazione alla pagina 1302

Funzionalità esclusive di Enterprise 11

Migrazione di bots con i seguenti attributi:
• Bots con timeout specificato nella proprietà
• Bots che contengono il comando Automazione GUI con l'opzione Ripristina finestra o

Esegui script selezionata
• Bots che aprono una sessione per l'Terminal Emulator e Microsoft Excel nel bot padre e chiudono

tale sessione nel bot figlio
• Bots che automatizzano le attività relative alla posta elettronica in Microsoft Exchange 2013
• Bots che utilizzano BAPI SAP standard e flussi di lavoro personalizzati per automatizzare le

attività nelle applicazioni SAP
• Bots che contengono il comando Window con l'opzione Chiudi tutte le finestre aperte

selezionata per chiudere tutte le finestre multiple attive (ID caso Service Cloud: 00773227)

RPA Workspace

Novità

Risparmio di larghezza di banda sui dispositivi mediante pacchetti bot offline
precaricati
I pacchetti bot personalizzati o più comunemente utilizzati in un bot vengono ora salvati offline
su un dispositivo utente nella seguente nuova cartella: AAPreloadedPackages. Quando un
bot viene distribuito sul dispositivo di un utente, i pacchetti vengono utilizzati da questa cartella
AAPreloadedPackages invece di scaricarli dalla Control Room.
Quando è disponibile una versione specifica del pacchetto, è possibile scaricarla dall'archivio della
Control Room per risparmiare il tempo necessario per scaricare il pacchetto durante l'esecuzione del
bot.
Preload packages alla pagina 2004 | Dispositivi alla pagina 2628
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Novità

Introduzione al package di file di testo
È ora disponibile un nuovo package di file di testo che include l'action Ottieni testo. Con questa
action è possibile estrarre il testo dai file che contengono caratteri giapponesi con codifica Shift-JIS
e quindi salvare il contenuto nei file in una variabile stringa.
Text file package alla pagina 1915

Nuova actions nel package Window
• Utilizzare l'action Chiudi tutto per chiudere tutte le finestre o i programmi in esecuzione sul

sistema, ad eccezione delle finestre aggiunte nel campo Aggiungi finestra.
• Utilizzare l'action Ripristina per ripristinare le dimensioni di una finestra o di un'applicazione

ingrandita o ridotta a icona in esecuzione sul sistema.

Window package alla pagina 1929

Condivisione di una sessione tra bots
È possibile condividere una sessione di DLL, Excel e dell'Emulatore di terminale tra più bots
utilizzando l'opzione Sessione globale. È anche possibile condividere una sessione con bots
figlio specifici utilizzando l'opzione Variabile e condividere una sessione solo con il bot corrente
utilizzando l'opzione Sessione locale.
Sharing sessions across bots alla pagina 1487

Miglioramenti al package Excel advanced
• Aprire i file con le estensioni .xml e .txt usando l'action Apri.
• Utilizzare il carattere jolly (*) nell'action Apri per i nomi di file per eseguire la ricerca in base al

modello di carattere jolly.
• Quando si utilizza l'action Esegui macro e si specifica un argomento che ha un valore vuoto,

questo valore vuoto può ora essere passato alla macro.

Nuova opzione nel database: Disconnect action
In Database:action Disconnetti, è ora possibile utilizzare l'opzione Mantieni lo schema del
database nella cache fino al termine dell'esecuzione del bot per consentire all'action Ciclo
di iterare il set di dati utilizzando lo schema memorizzato nella cache dopo la disconnessione dal
database.

Nome TNS supportato per la connessione al Oracle Database
Il nome TNS (Transparent Network Substrate) è ora supportato nel Oracle Database. È possibile
connettersi al Oracle Database specificando il nome TNS e il percorso del file di configurazione
tnsnames.ora.

Nuova versione di Exchange supportata nel package Email
Nel package Email, quando si sceglie un server EWS per stabilire una connessione, è ora possibile
utilizzare l'opzione Exchange2013 nel campo Versione Exchange.

Miglioramenti al AISense Recorder
Il AISense Recorder ora consente l'automazione di applicazioni che utilizzano interfacce in russo e
una combinazione di interfacce in russo e inglese.
AISense per la registrazione di attività da applicazioni remote alla pagina 1965
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Novità

Miglioramenti delle condizioni del registratore per i packages
• Utilizzare la nuova condizione L'oggetto non esiste dall'elenco delle condizioni di qualsiasi

package per verificare se un oggetto specifico esiste in una finestra e quindi eseguire delle
actions in base al risultato.
Questa condizione funziona anche con la tecnologia SAP.

• La condizione di Oggetto esistente viene ora rinominata in L'oggetto esiste.

Loop package alla pagina 1681

Supporto migliorato per URI di SOAP Web Service (ID caso Service Cloud: 00759811)
Nel package SOAP Web Service, se il campo Indirizzo posizione è vuoto, il bot ora recupera
l'indirizzo posizione dal file WSDL.

Nuova opzione nel package SOAP Web Service
Utilizzare l'opzione Genera richiesta SOAP nel package SOAP Web Service per recuperare
i dettagli della richiesta SOAP dall'URI SOAP o dal file WSDL. È ora possibile selezionare
qualsiasi operazione dall'elenco di servizi e porte disponibili nella richiesta SOAP per compilare
automaticamente i dati nei campi dell'action SOAP Web Service.
Esempio di utilizzo dell'azione Servizio Web SOAP alla pagina 2076

New option in REST Web Service (Service Cloud case ID: 00764198, 00800287)
In the REST Web Service package, you can now use the Allow insecure connection when
using https option to skip SSL certificate validation and to allow non-secure connections.

Clic relativo e occorrenza supportati nei packages (ID caso Service Cloud:
0055643,00754173)
Quando si acquisisce un'immagine di destinazione tramite il package Image Recognition, è ora
possibile utilizzare l'opzione Anteprima per selezionare un'occorrenza acquisita specifica e
posizionare la posizione del clic in relazione all'immagine.
Questa funzione è supportata nei seguenti packages e actions:
• Image Recognition > Trova l'immagine nella finestra
• Image Recognition > Trova la finestra nella finestra
• If > Condizione di Riconoscimento delle immagini
• Loop > Condizione Durante > Riconoscimento delle immagini
• action Attendi la condizione > Condizione di Riconoscimento delle immagini

Using Find image in window action alla pagina 1632|Using the Find window in window action alla pagina
1635

Opzione di tempo di attesa nel package Google Sheets (ID caso Service Cloud: 00738249,
00817449, 00814775)
Nel package Google Sheets, quando si utilizza l'action Connetti per stabilire una connessione con il
server Google, è ora possibile impostare un tempo di attesa nel campo Attendi il completamento
dell'azione durante l'esecuzione di actions quali Ottieni, Imposta o Elimina. Ad esempio, se
si dispone di un file di grandi dimensioni che richiede molto tempo per l'apertura, è ora possibile
impostare il tempo di attesa per l'apertura del file prima che il sistema esegua il set successivo di
actions.
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Novità

Nuova opzione per l'action Metti del package Dictionary
You can now assign a static value to a key for a dictionary variable by using the Static value
option in the Put action in the Dictionary package.
Dictionary package alla pagina 1479

Applicazioni Java supportate nel package di integrazione app
Il package di integrazione app ora supporta applicazioni Java basate su Standard Widget Toolkit
e Abstract Window Toolkit, che possono disegnare testo utilizzando API di disegno del testo di
Windows.

Use regular expressions in File > Open action  (Service Cloud case ID: 00737614)
Utilizzare le espressioni regolari (regex) nell'action Apri del package File per supportare la ricerca
basata su modelli.

Specifica del timeout per bots (ID caso Service Cloud: 00667049, 00690892, 00699158,
00706491, 00739420, 00739415, 00741590, 00769795)
È ora possibile specificare l'intervallo di tempo entro il quale deve essere completata l'esecuzione
di un bot. Il sistema interrompe l'esecuzione del bot se non viene completata entro l'intervallo di
tempo specificato.
Configurare il timeout per l'esecuzione di bot alla pagina 2017

Nuova opzione per la ricerca di testo all'interno del contenuto del bot in Bot editor (ID
caso Service Cloud: 00735685, 00736201, 00739122, 00740481, 00733885, 00748970, 00746459,
00738181,00756441,00759037,00761453,00764478)
In Bot editor, utilizzare la casella di ricerca nella visualizzazione Flusso, Elenco o Doppia per cercare
testo, variabili o actions nel contenuto dell'intero bot, come nome del pacchetto, nome dell'azione,
nome della stringa o nome della variabile. Questa funzione consente di visualizzare o modificare un
bot con lunghe righe di codice per determinare dove e in quale linea viene utilizzato il testo cercato,
ad esempio variabili, stringhe o actions.
Actions palette for bot creation alla pagina 1363

Miglioramenti alla struttura del bot
Abbiamo migliorato la leggibilità complessiva della struttura del bot e aggiornato le etichette dei
nodi del bot per visualizzare in dettaglio le proprietà e i parametri selezionati di ciascuna action
nelle visualizzazioni Flusso, Elenco e Doppia. Non è più necessario espandere ciascuna action per
visualizzare questi dettagli.
Le visualizzazioni Flusso, Elenco e Doppia visualizzano le seguenti proprietà delle actions:
• Il valore immesso per le actions, ad esempio Imposta testo per tutte le tecnologie supportate
• I nomi degli oggetti su cui sono eseguite le actions, ad esempio Imposta testo, Fai clic, Clic

sinistro, Ottieni proprietà e Seleziona elemento per indice
• Il nome della proprietà dell'oggetto menzionata nell'action
• Il nome della variabile restituita se un valore è assegnato a una variabile
• L'elenco delle proprietà per l'action Ottieni proprietà
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Controllo della sicurezza di rete migliorato
In qualità di amministratore della Control Room, è ora possibile configurare e controllare URL
specifici e consentiti per un controllo più granulare dei punti di accesso alla rete.
Set callback URLs alla pagina 2736

Supporto proxy migliorato
Le connessioni a Internet vengono spesso eseguite tramite server proxy. Automation 360 fornisce
un supporto avanzato per la configurazione proxy per pacchetti quali i pacchetti REST e SOAP, per
la creazione e l'esecuzione di bots.
Connettere Bot Agent a un dispositivo con un proxy alla pagina 1046

Connessione ad Azure DevOps (Cloud) Git da Control Room
È ora possibile connettersi ad Azure DevOps (Cloud) Git tramite la Control Room per eseguire il
check-in di un bot e dei relativi file dipendenti nell'archivio remoto di Azure DevOps (Cloud) Git.
Connect to Azure DevOps Git from Control Room alla pagina 2757

Filtri per l'ID dell'elemento di lavoro e l'ora per le automazioni dei carichi di lavoro
Combinare l'ID dell'elemento di lavoro e l'ora di inizio di una coda per cercare elementi di lavoro
specifici e monitorare l'avanzamento di tali elementi di lavoro. L'ora di inizio filtra l'elenco di tutti gli
elementi di lavoro che iniziano tra la data di inizio e l'ora di inizio specificate.
Actions allowed on view queue page alla pagina 2818

Miglioramenti alla chiave del tipo di esecuzione nella variabile AATaskExecutor
• When you schedule a bot to run, the Execution_Type key in the AATaskExecutor variable now

returns information about the execution type with schedule type (frequency) such as Run as
 schedule Daily, Run as schedule Weekly, or Run as schedule Monthly.

• When you use a trigger in a bot, the Execution_Type key can be accessed through the
trigger data. The Execution_Type key returns the Run through Trigger as a string for
triggers.

Supporto delle lingue per i nomi delle variabili
I nomi delle variabili ora supportano le lingue greca e giapponese. È ora possibile creare i nomi
delle variabili utilizzando i seguenti caratteri:
• Caratteri greci maiuscoli e minuscoli
• Caratteri giapponesi Katakana a larghezza intera e a mezza larghezza.

Supporto dei servizi ML nel programma di installazione dei pacchetti Linux
Il pacchetto Python nel pacchetto di installazione di Linux è ora aggiornato per supportare I servizi
ML. Quando si scarica e si installa la Control Room su Linux, i servizi ML sono attivi e in esecuzione
come parte del processo di installazione.
Installing Control Room on Linux alla pagina 948 | Stop and start Control Room services on Linux alla
pagina 2795
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Supporto per il download diretto in Bot Store
Gli utenti che non possono connettere la propria Control Room a Internet possono ora scaricare
direttamente bots e packages di Automation 360 localmente da Bot Store e importarli nella propria
Control Room.
Download locally and import bots and packages from Bot Store to Control Room alla pagina 2947

Miglioramento della gestione del database MS-SQL
Gli amministratori non devono più reinstallare Automation 360 per avere la possibilità di modificare
le impostazioni relative alla configurazione di MS-SQL. Le impostazioni modificabili includono nome
utente, password, nome del server di database, IP del server di database e numeri di porta.

Cosa è cambiato

Changes to Runtime Window
Il titolo sulla Finestra di runtime è ora cambiato in Bot in esecuzione dal precedente
Automation Anywhere.
Se si verifica qualche problema nella tua automazione a causa di questo cambio di titolo, consulta
questo articolo su come risolverlo: A360.22 | Runtime Window: Minimize Command Fails Due to Title
Change (A-People login required)

Modifiche al package Run DLL
• L'action Esegui funzione (Legacy) non è più disponibile nel package Run DLL. Si raccomanda

di utilizzare l'action Esegui funzione dal package Run DLL poiché questa action è una versione
migliorata dell'action Esegui funzione (Legacy).
Notare che i bots esistenti che utilizzano Esegui funzione (Legacy) continueranno a essere
eseguiti correttamente senza alcun problema.

• L'azione Imposta variabile di sessione non è più disponibile nel package Run DLL. Instead,
we recommend that you create a new DLL session using the Variable option in the Open
action of the Run DLL package.
Notare che i bots esistenti che utilizzano l'azione Imposta variabile di sessione
continueranno a essere eseguiti correttamente senza alcun problema.

Messaggi per i bots migrati per i quali la logica MetaBot di riferimento non è disponibile
Bot Scanner e Assistente migrazione ora visualizzano i messaggi relativi all'azione richiesta per i
bots Enterprise 11 o Enterprise 10 per i quali la logica MetaBot di riferimento non è disponibile.

La migrazione di bots con variabili mancanti è bloccata
Il processo di migrazione non esegue la migrazione di bots Enterprise 11 che utilizzano una
variabile che non è più disponibile e che viene utilizzata nei comandi If, Loop, Variable Operation
o Clipboard. In precedenza, la migrazione di questi bots veniva eseguita correttamente, ma si è
verificato un errore durante l'esecuzione dei bots.
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Aggiornamento a MetaBots che utilizzano la stessa DLL nella logica multipla (ID caso
Service Cloud: 00684185, 00730248, 00742840, 00742840, 00779629, 00779788, 00727977,
00743986, 00764872)
I bots migrati che utilizzano la stessa DLL nella logica MetaBot multipla ora funzionano come
previsto senza alcuna modifica. In precedenza, era necessario aggiornare i bots migrati per eseguirli
correttamente.

Esecuzione corretta dei bots migrati quando le variabili mappate non sono disponibili
(ID caso Service Cloud: 00746651, 00785703)
I bots migrati ora sono eseguiti correttamente quando le variabili mappate non sono disponibili nel
bot figlio o nel bot padre.

Miglioramenti alle impostazioni dispositivi dell'Bot Agent
Per accedere facilmente ai dispositivi locali e remoti, l'utente può modificare le impostazioni
dispositivi dell'Bot Agent dalla pagina Le mie impostazioni che si trova nel pannello della Control
Room sotto il nome utente. Puoi effettuare le seguenti operazioni:
• Aggiornare le credenziali di un dispositivo
• Modificare il dispositivo Bot Runner predefinito
• Visualizzare il nome del dispositivo locale, lo stato e la versione dell'Bot Agent

Set user device credentials alla pagina 1052 | View and update Bot Agent device settings alla pagina 1053

Miglioramento dell'individuazione automatica per domini multipli
È ora possibile configurare il numero massimo di siti che possono essere individuati nel dominio
nel file um.properties per una Control Room configurata per l'individuazione automatica su più
domini in luoghi diversi.
Configure Control Room for Active Directory: auto mode alla pagina 984

Miglioramento di OpenDistro per Elasticsearch
Nell'ambito della protezione avanzata, OpenDistro (cron-utils) è ora aggiornato alla versione
v.1.13.2 per Elasticsearch v.7.10.2

Aggiornamento del package stampante
Nelle actions Rimuovi e Imposta stampante predefinita del package stampante, è ora
possibile selezionare una stampante specifica dall'elenco delle stampanti disponibili.
Printer package alla pagina 1743

Inserimento delle azioni registrate al centro di un bot
È ora possibile inserire le azioni registrate acquisite di recente in una posizione specificata in un
bot esistente. In precedenza, le azioni registrate venivano aggiunte al bot esistente alla fine per
impostazione predefinita e gli utenti dovevano trascinare l'azione nella posizione specificata.
Universal Recorder for object-based automation alla pagina 1949
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Migrazione: comportamento delle variabili di sistema all'esterno di un ciclo (ID caso
Service Cloud: 00761281)
Quando si esegue la migrazione dei bots che utilizzano variabili di sistema al di fuori del package
Loop, le variabili vengono ora convertite in variabili definite dall'utente di tipo record o stringa, a
seconda dei casi, e assegnate a un'azione record. Di conseguenza, quando vengono eseguiti i bots
che contengono queste variabili, vengono visualizzati i dati dell'ultima riga. In precedenza, dopo la
migrazione veniva visualizzato un valore vuoto.
Le seguenti variabili di sistema vengono convertite in variabili di tipo record:
• $Filedata Column$
• $Excel Column$
• $Dataset Column$
• $Table Column$

La variabile di sistema $XML Data Node$ viene convertita in una variabile di tipo stringa.
Mappatura delle variabili per la migrazione alla pagina 1279

Supporto rimosso per l'attributo Reindirizza URI nel package Google Sheets (ID caso
Service Cloud: 00777287)
L'attributo Reindirizza URI nell'action Connetti del package Google Sheets è stato rimosso.
After updating to this release from previous Automation 360 releases, you can continue to
successfully execute your bots by entering the fixed redirect URL in Google Cloud Platform:
http://localhost:8888/Callback

Aggiornamenti alle credenziali dispositivo registrate nel log di audit (ID caso Service
Cloud: 00691511)
È ora possibile visualizzare le voci del log di audit se le credenziali del dispositivo vengono
aggiornate manualmente tramite l'Bot Agent del dispositivo o tramite l'API della Control Room.
Vengono registrati i dettagli delle attività, ad esempio il nome dell'utente che aggiorna le credenziali
del dispositivo e l'ora dell'aggiornamento.

Miglioramenti al Image Recognition package
Quando è attivata la registrazione sicura, l'immagine di destinazione acquisita tramite l'actions nel
package Image Recognition viene nascosta dopo l'acquisizione iniziale per migliorare la sicurezza.
In precedenza, l'utente era in grado di visualizzare l'immagine di destinazione anche quando era
abilitata la registrazione protetta.
Image Recognition package alla pagina 1631

Miglioramenti al File and Folder package
Gli utenti con un'autorizzazione di ruolo valida possono ora creare un collegamento al file di origine
selezionato in una posizione specifica utilizzando l'action Crea collegamento nel package File and
Folder.

Supporto del metodo HTTP HEAD (ID caso Service Cloud: 00754096)
The HTTP method HEAD is now supported as an API call to connect to the load balancer of a
Control Room configured for high availability.
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Aggiornamento all'installazione di Linux e al percorso di log
• File di installazione

• Se si utilizza una versione precedente a Automation 360 v.22 o se si è eseguito
l'aggiornamento da una versione precedente alla v.22, i file di installazione sono ora archiviati
in questo percorso /opt/automationanywhere/enterprise

• Se si esegue una nuova installazione della versione v.22, i file vengono archiviati in questo
percorso: /opt/automationanywhere/automation360

• File di log
• Se si utilizza una versione precedente alla v.22 o se si è eseguito l'aggiornamento alla v.22

da una versione precedente, i file di log sono memorizzati in questo percorso: /var/log/
automationanywhere/enterprise

• Se si esegue una nuova installazione della versione v.22, i file di log vengono archiviati in
questo percorso: /var/log/automationanywhere/automation360

Estrazione di un TaskBot con una versione specifica
Se un bot ha più versioni, è ora possibile selezionare ed estrarre la versione specifica del bot. Come
Bot Creator questo consente di ripristinare una versione precedente del bot.

Signed DLLs for bots and packages
Automation 360 ora firma tutte le DLL, incluse le DLL di terze parti, per bots e packages.
Le seguenti sono eccezioni:
• Il package IQ Bot Pre-processor non ha una nuova versione in questa versione Automation 360

v.22. La versione del pacchetto v.21 viene copiata in quella v.22 senza modifiche, incluse alcune
DLL non firmate.

• Al package di Process Discovery in questa versione v.22 non è applicata la firma.
• Automation Anywhere
• Azul Systems (Java JRE in Bot Agent)
• TeamDev Ltd. (third-party library)

Correzioni

ID caso Service Cloud Descrizione

00712808, 00765752 Nelle versioni precedenti, i file correlati a Automation Anywhere
venivano a volte generati in C:\Windows\Temp. This issue is now
fixed.

00800392 Non si verifica più un errore quando si esegue la migrazione da una
versione Enterprise 11 in cui un database è memorizzato su Google
Cloud Platform.

00811887 L'utilità di migrazione nel cloud non riscontra più un errore quando si
utilizza un numero di porta personalizzato per connettersi al database
Enterprise 11.

00815097 I bots Enterprise 11 estratti da un utente vengono ora migrati
correttamente in Automation 360 Cloud.

© 2023 Automation Anywhere. All rights reserved.     359



    Automation Anywhere - Learn

Correzioni

ID caso Service Cloud Descrizione

00802360 È ora possibile aggiornare il valore degli attributi delle credenziali
Enterprise 11 dopo che sono stati migrati in Automation 360 Cloud.
In precedenza, il sistema riscontrava un errore quando si aggiornava
il valore di un attributo di credenziale aggiunto o aggiornato da un
utente in Enterprise 11 e tale utente non era più disponibile quando i
dati Enterprise 11 venivano migrati in Automation 360 Cloud.

-- Quando si esegue la migrazione da Enterprise 11 a Automation 360
Cloud, non si verifica più un errore quando un armadietto viene
eliminato in Enterprise 11 ma le relative autorizzazioni sono ancora
utilizzate in altre entità.

-- Non si verifica più un errore quando si aggiorna da Version 11.3.5.2 a
qualsiasi versione Enterprise 11 e poi si esegue la migrazione da quella
versione Enterprise 11 a Automation 360 Cloud.

-- Le opzioni Aggiorna e Indietro sono ora disponibili nella schermata
Riepilogo dell'utilità di migrazione nel cloud quando non è disponibile
abbastanza spazio su disco per memorizzare il backup dei Enterprise
11 Control Room dati.

00787240, 00781349 I bots migrati non riscontrano più un errore quando un bot padre e il
relativo bot figlio vengono aperti tramite Internet Explorer e il bot figlio
estrae una tabella da Internet Explorer.

-- Ora non esiste alcuna limitazione al numero di connessioni ActiveMQ
consentite quando si esegue un'automazione che viene eseguita 5
volte, con ogni ciclo eseguito su 20 bots. Nelle versioni precedenti,
l'automazione a volte non riusciva dopo il quarto ciclo.

0074312 È ora possibile migrare correttamente i bots che contengono
l'operazione Ritaglia della Stringa e l'output viene assegnato alla
variabile Matrice.

00760963 I bots migrati che contengono il comando Vai alla cella ora
funzionano correttamente in Automation 360 dopo la migrazione.

-- L'utilità Bot Scanner ora carica il file cache.properties modificato
dalla cartella conf. In precedenza, era necessario inserire il file
cache.properties modificato nella posizione del file eseguibile
sullo Bot Scanner affinché il file fosse caricato.

00754003 I Bots che contengono il comando SOAP Web Service vengono ora
eseguiti correttamente dopo la migrazione senza che siano riscontrati
errori. In precedenza, si verificava un errore imprevisto quando
non veniva richiamato il SOAP Web Service con WSDL definito con
dipendenze esterne.

00790360 Nel package Emulatore di terminale, quando si invia una chiave
al terminale con l'azione Invia testo o Invia chiave, se il terminale
si trova nello stato occupato o la tastiera è nello stato bloccato,
queste azioni attendono ora 5 secondi che il terminale torni nello
stato normale. Dopo 5 secondi, il sistema passa ad eseguire l'azione
successiva senza alcuna eccezione.
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ID caso Service Cloud Descrizione

00742000 I bots migrati che contengono il comando Richiedi > Per valore
con l'opzione Non scrivere in nessuna finestra selezionata ora
funzionano come previsto in Automation 360 dopo la migrazione
e nessun testo viene scritto nel file se una finestra è aperta. In
precedenza, anche se questa opzione era selezionata, se una finestra
del file di testo era aperta, il testo era scritto nel file.

00781072 Quando i bots vengono migrati utilizzando Bot Migration Wizard, la
migrazione non fallisce più se il nome del bot include un carattere
speciale. In precedenza, si verificava un errore interno quando il nome
del bot includeva un carattere di apostrofo (').

00780713, 00778164 Un bot migrato non si blocca più quando tale bot utilizza il package
App Integration per acquisire testo da un'applicazione di destinazione e
l'applicazione di destinazione non risponde.

-- I bots Enterprise 11 migrati che utilizzano il comando Terminal
Emulator per cancellare la schermata del terminale dei terminali di tipo
VT e ANSI non riscontrano più un errore quando vengono eseguiti.

00748647 I bots migrati in Enterprise 11 che utilizzano una matrice
bidimensionale e il comando Variable Operation non riscontra più
errori. In precedenza, il processo di migrazione era utilizzato per
impostare il numero di righe e colonne per la matrice bidimensionale
su 1x1 indipendentemente dai valori impostati in Enterprise 11.

-- Il processo di migrazione continua a eseguire la migrazione dei bots
se la connessione tra Control Room e Bot Agent viene persa e poi
ristabilita. In precedenza, il processo di migrazione non riusciva
quando la connessione tra Control Room e Bot Agent veniva interrotta.

00764441 In Excel: Ottieni cella singola, action del package Excel avanzato,
è ora possibile accedere al valore di una cella specifica definita
nell'indirizzo della cella. In precedenza, i bots migrati rilevavano un
errore Deve corrispondere al modello quando veniva immesso
un carattere giapponese nel campo Indirizzo cella.

00757713, 00764985,
00820376

Il package Excel avanzato consente ora di leggere un foglio
protetto. In precedenza, i bots migrati riscontravano un errore
quando si recuperava una cella da un foglio protetto utilizzando Excel
avanzato:action Apri.

00761911 È ora possibile eseguire la migrazione dei bots utilizzando la variabile
di sistema della Colonna Excel dove la chiave è il nome della
colonna; non si verifica più un errore.

00769321 I bots migrati non riscontrano più un errore quando il comando
Esegui macro Excel è incluso nei bots. I bots migrati vengono ora
eseguiti correttamente utilizzando l'action Esegui macro del package
Excel avanzato.

00790858 È ora possibile eseguire la migrazione di un bot quando è presente
una variabile non corrispondente e il relativo comando è disattivato.
In precedenza, quando al bot veniva assegnato un determinato tipo di
variabile e il comando Funzionamento variabile in tale variabile era
disattivato, l'utilità Bot Scanner visualizzava un errore per la variabile
quando il tipo veniva successivamente modificato.
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ID caso Service Cloud Descrizione

00744318, 00744326,
00745318

È ora possibile scaricare un file di bot esportato con caratteri
giapponesi nel nome del file tramite e-mail. In precedenza, quando un
file esportato con un nome giapponese veniva scaricato utilizzando il
collegamento e-mail, si verificava un errore o i caratteri nel nome file
dello zip esportato erano distorti e .zip veniva aggiunto al nome file.

00762975 Dopo la migrazione dei bots Enterprise 11 che utilizzano il comando
Gestione errori con la funzione Invia e-mail e l'opzione Allega
variabile e Allega istantanea, i bots ora inviano correttamente e-
mail di errore con allegati contenenti un'istantanea o un file di testo
della variabile.

00731577, 00746226,
00760649, 00759973,
00767618, 00789545,
00821824

The includePackages parameter of the Export API now works as
expected. Se si imposta il valore del parametro su Vero, i pacchetti
vengono inclusi nel file esportato e, se il valore è impostato su Falso, i
pacchetti non vengono inclusi nel file esportato.

-- È ora possibile eseguire la migrazione di bots con nomi di variabili che
includono caratteri a larghezza intera e minuscoli. In precedenza, la
migrazione dei bots con un nome di variabile che includeva caratteri
a larghezza intera e caratteri maiuscoli non era supportata perché
la variabile veniva erroneamente convertita in un carattere a metà
larghezza.

00759189 I bots migrati ora utilizzano il formato data specificato nel valore
globale AADefaultDateFormat per l'automazione relativa alla posta
elettronica. È necessario creare il valore globale AADefaultDateFormat
prima di eseguire la migrazione dei bots e specificare il formato della
data che si desidera utilizzare nei bots.
Azione consigliata: Specificare nel valore globale
AADefaultDateFormat lo stesso formato data utilizzato in Enterprise 11.

00784001 I bots Enterprise 11 che vengono migrati ora contengono tutte le
proprietà di un oggetto acquisito da un'applicazione SAP.

00786362, 00802274 I bots Enterprise 11 che vengono migrati non riscontrano più un
errore quando il bot figlio e il bot padre utilizzano versioni diverse del
package If.

00807986 I bots Enterprise 11 che vengono migrati non riscontrano più un errore
quando una variabile mappata tra un bot figlio e il bot padre non è
disponibile nel bot figlio.

00808026 I bots Enterprise 11 che vengono migrati non riscontrano più un errore
quando utilizzano una sessione condivisa per le attività correlate
all'Terminal Emulator quando una sessione viene condivisa tra bots
figlio nidificati e un bot figlio intermedio non contiene actions Terminal
Emulator.
Ad esempio, si supponga di avere tre bots: Bot1, Bot2 e Bot3, dove
Bot1 chiama Bot2 e Bot2 chiama Bot3. Bot1 e Bot3 condividono
una sessione per le attività correlate all'Terminal Emulator; tuttavia,
Bot2 non contiene actions del package Terminal Emulator. Quando si
condivide una sessione tra Bot1 e Bot3, non si verifica più un errore.
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00762368 In precedenza, quando i bots venivano migrati utilizzando processi di
database Oracle con password contenenti il simbolo, si verificava un
problema. Il problema è stato ora risolto e le password che utilizzano il
simbolo “@” sono ora supportate.

00768466, 00769099 Non si verifica più un errore quando si esegue la migrazione di
MetaBots che contengono logica disponibili all'interno di una cartella.

00772885 Il sistema recupera ora tutte le righe di una tabella in un'applicazione
SAP quando l'ultima pagina della tabella contiene una sola riga.

00801733 Non si verifica più un aumento dell'utilizzo della CPU quando la Control
Room è inattiva.

00774821 Non si verifica più un errore quando si eseguono bots migrati che
contengono un'action Loop all'interno di un'altra action Loop.

00786732 Per i bots Enterprise 11 che utilizzano il comando Estrai tabella
insieme ad altri comandi all'interno del comando Error Handling e
solo il comando Estrai tabella è disattivato, solo l'action equivalente
al comando Estrai tabella viene disattivata dopo la migrazione.
In precedenza, tutte le actions all'interno dell'azione Error Handling
venivano disattivate nel bot migrato.

00743892 Non si verifica più un errore quando si eseguono bots migrati che
utilizzano DLL che restituiscono un valore di tipo definito dall'utente.
Tali valori vengono convertiti nel tipo stringa nei bots migrati.

-- I bots Enterprise 11 che utilizzano operazioni variabili per reinizializzare
una variabile di tipo array in modo che contenga più di 160.000 celle
(ad esempio, 400 righe e 400 colonne o 800 righe e 200 colonne) non
riscontrano più un errore quando vengono eseguiti dopo la migrazione.

00737025 I bots Enterprise 11 che passano variabili di sistema come Mese, Anno
e Giorno come variabile di input a un MetaBot non riscontrano più un
problema dopo la migrazione.

00773407 In precedenza, i report della cronologia attività esportati in CSV non
visualizzavano correttamente l'informazione Ultima modifica poiché
alcune delle informazioni di Data di modifica e Modifica di non
venivano elaborate in modo corretto. L'errore è stato risolto e i report
della cronologia attività possono ora essere esportati correttamente in
file CSV.

00767597 Il valore (data) Ultima modifica visualizzato nella cronologia delle
attività e nella pagina di report del bot non era in precedenza tradotto
correttamente quando la lingua della Control Room veniva cambiata da
inglese a una non inglese e quindi riportata alla lingua inglese. Questo
errore è ora risolto e i dati vengono conservati quando la lingua viene
modificata nella Control Room.

00762975 Il testo in lingua giapponese è ora aggiornato nell'interfaccia per le
modifiche recenti dell'esperienza utente (UX). In precedenza, c'erano
alcuni errori nel testo tradotto nell'interfaccia, che ora sono stati
corretti.
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00763228, 00776154 I vincoli del database, come le violazioni dei vincoli delle chiavi
esterne, impedivano in precedenza agli utenti di eliminare i bots dopo
la migrazione. Questa limitazione è stata risolta e gli utenti possono
eliminare i bots migrati (file .atmx) senza problemi.

00749375,00763262 Dopo la migrazione, se la codifica del file di testo è stata impostata
su UNICODE o UTF8, è ora possibile utilizzare la chiave Stringa:
Importa stringa da file di testo per leggere i valori dal file di testo
durante il runtime del bot.

00739268 È ora possibile eseguire senza problemi la migrazione dei bots con dati
html di grandi dimensioni associati al comando Object Cloning.

00674147, 00682390 L'action Arresta servizio del package Servizi ora consente
di arrestare tutti i servizi figlio e dipendenti di una finestra o di
un'applicazione selezionata. In precedenza, il servizio dipendente non
si arrestava automaticamente quando un utente tentava di arrestare
qualsiasi servizio di una finestra o di un'applicazione.

00754835 I dispositivi temporanei vengono eliminati automaticamente se
l'opzione di eliminazione automatica è attivata per le impostazioni del
dispositivo nella Control Room.

00751058, 00761099 Quando si utilizza l'action Connetti del Database per l'automazione del
carico di lavoro, gli elementi di lavoro della seconda iterazione vengono
ora eseguiti per l'automazione. In precedenza, veniva eseguito solo il
primo elemento di lavoro nell'automazione del carico di lavoro.

00771098 Dopo aver modificato una pianificazione dalla pagina Attività
programmata e salvato la programmazione, viene ora aperta la
pagina corretta (Attività programmata) anziché la pagina Attività
in corso.

00733614, 00741358 È ora possibile utilizzare l'action Estrai immagine del package PDF
per convertire un file di PDF che contiene immagini JPX in qualsiasi
altro formato di immagine. In precedenza, l'azione non riusciva a
estrarre l'immagine dal file di PDF perché il lettore di immagini JPX non
era supportato.

00765851 Le actions Recorder ora funzionano correttamente e non causano alcun
ritardo quando il valore Imposta testo contiene parentesi o [] (il che
consente di eseguire un bot migrato senza ritardi). In precedenza,
l'esecuzione di un bot richiedeva un tempo maggiore quando Imposta
testo conteneva [] (parentesi).

00771197 Nell'action Apri del package Browser, la descrizione sotto il campo
Time out dopo (secondi) (opzionale) è ora tradotta correttamente
come Min = 9 secondi nella lingua giapponese. In precedenza, la
descrizione era tradotta come Max = 9 secondi.

00761395 Nel package Database, quando si esegue la connessione con Oracle
Database e si utilizza l'azione Leggi da in un ciclo per recuperare
record dal database, il bot viene ora eseguito correttamente. In
precedenza, l'esecuzione del bot non riusciva per un errore.

00727530 L'action Sposta tutti nel package Email ora funziona correttamente e
non si verifica alcun problema.
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00739978 Non si verifica più un errore quando si sceglie l'opzione Input
manuale per aprire un file di script VB.

00728180 Il problema con i trigger di evento quando si creano cartelle in blocco
è stato risolto. Se si configura un trigger di evento per avviare un
bot ogni volta che viene creata una cartella e poi si creano cartelle
in blocco, il bot viene ora distribuito per ogni cartella creata. In
precedenza, il bot non veniva distribuito per tutte le cartelle create.

00711134, 00750164,
00847916

Se si configurano più trigger per avviare bots basati su eventi di
file e se tutti i file risiedono nella stessa cartella, i bots associati a
tutti i trigger vengono ora distribuiti. In precedenza, solo alcuni bots
venivano distribuiti.

00719612 Quando si accede alla Control Room come Bot Runner non assistito, è
ora possibile eseguire i bots mediante l'opzione Esegui come auto.
Previously, an unattended Bot Runner could not run the bot with the
Run as self option even when the device was set as the default
device.

00745095 Nel package Database, quando ci si connette al database Microsoft
Access utilizzando la connessione JDBC, la query Select estrae ora
il nome del file per il tipo di dati Allegati. In precedenza, veniva
visualizzato un errore.

00772194 I dati di qualsiasi tipo di database vengono ora esportati correttamente
nel formato CSV. In precedenza, se i dati presentavano caratteri
speciali come le virgolette doppie, l'output veniva visualizzato in una
nuova riga.

00773961 Quando si crea un nuovo foglio di lavoro per nome nel package Google
Sheets, non si verifica più un errore quando si esegue il bot.

00762029 Non si verifica più un errore quando si esegue un bot utilizzando il
package Google Calendar. In precedenza, quando si utilizzava l'action
Disconnetti per terminare la connessione, l'attributo dell'indirizzo e-
mail veniva memorizzato nel nome della sessione anziché nell'attributo
del nome della sessione utente. Di conseguenza, l'esecuzione del bot
non riusciva per un errore.

00758333 Se tutte le versioni di un particolare package sono disattivate, il
package non è più elencato nella tavolozza Azioni di un Bot editor.
In precedenza, quando un pacchetto era disattivato, il Bot Creator
lo visualizzava ancora nella tavolozza Azioni e gli utenti potevano
utilizzare il pacchetto durante la creazione di un bot. Tuttavia,
l'esecuzione di questi bots non riusciva perché il package era
disattivato.

00780221 Un bot creato utilizzando l'action Esegui funzione nel pacchetto
Run DLL ora viene eseguito senza problemi. In precedenza, veniva
visualizzato un errore durante l'esecuzione del bot a causa della non
disponibilità di alcune risorse incorporate, ad esempio l'assembly
satellite.
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-- Non si verifica più un errore quando si crea un bot utilizzando l'action
Invia testo del package Terminal Emulator e si passa una variabile
con un valore vuoto. In precedenza, l'esecuzione del bot non andava
a buon fine quando venivano scelte opzioni di variabile (Credenziale,
Variabile, Stringa non sicura) che non presentavano alcun valore.

00776430 Quando si effettua la connessione al tipo di terminale TN3270E nel
package Terminal Emulator, si seleziona una delle opzioni del Modello
terminale dall'elenco e si esegue il bot, viene ora visualizzata la
risoluzione corretta dello schermo. In precedenza, veniva inviato un
valore errato per ciascun modello di terminale e veniva visualizzata una
schermata con una risoluzione errata.

00773415, 00781487 Quando si apre un foglio di calcolo nel package Google Sheets e
si seleziona l'opzione Inizio della riga nell'action Vai alla cella,
l'output viene ora visualizzato correttamente. In precedenza, l'output
veniva visualizzato a livello di colonna.

00773415, 00781493 Non si verifica più un errore quando si apre un foglio di calcolo nuovo
o vuoto nel package Google Sheets e si seleziona una action come
Vai alla cella o Imposta cella per eseguire un'operazione. In
precedenza, l'esecuzione del bot non riusciva per un errore.

00779561 Nel package System, quando si utilizza l'action Ottieni variabile
ambiente in modalità di visualizzazione, le variabili di ambiente
vengono sempre visualizzate nell'elenco. Utilizzare l'opzione di
aggiornamento per recuperare tutte le variabili di ambiente nell'elenco.
In precedenza, le variabili di ambiente a volte non venivano
visualizzate nell'elenco.

00775073 In the Excel advanced package Get worksheet as data table >
Read option, the description for the Read cell value option now
reads correctly as 50% will be read as 50 when it is translated
to the Japanese language. In precedenza, la descrizione veniva
tradotta come 50% sarà letto come 50%.

00767246 Il package SOAP Web Service ora funziona per gli URI, e l'endpoint
del servizio può essere passato come parametro URI. In precedenza,
veniva visualizzato un errore per tali richieste.

00734463, 00754570,
00766456

Quando l'action Connetti del package Database viene utilizzata
per stabilire una connessione con Microsoft SQL Server utilizzando
l'autenticazione Windows, il bot viene ora eseguito correttamente
anche quando i bots padre e figlio utilizzano versioni diverse del
package Database.
In precedenza, l'esecuzione del bot non riusciva se i bots padre e figlio
utilizzavano versioni diverse del package Database.

00780921 Non si verifica più un errore quando si utilizza l'action Estrarre
il testo da un file PDF per estrarre il testo da un file PDF. In
precedenza, quando veniva estratto da un file PDF del testo
strutturato, veniva visualizzato un errore perché l'indice superava
l'intervallo di 1000.
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-- Nel package Excel advanced, quando si utilizza lo stesso nome di
sessione per aprire più fogli di calcolo Excel, il bot visualizza ora un
errore durante l'esecuzione. In precedenza, se lo stesso nome di
sessione veniva utilizzato in più fogli di calcolo, il bot sovrascriveva la
sessione aperta esistente quando veniva eseguita la seconda action
Apri.

00785198 Nel package Data Table, quando si utilizza l'action Scrivi su file per
estrarre i dati da una tabella con record di grandi dimensioni, vengono
lette in batch e scritte in un file CSV 1000 righe di dati.
In precedenza, veniva visualizzato un errore Java di spazio dell'heap
perché la memoria heap Java configurata aveva esaurito lo spazio. Di
conseguenza, non era possibile recuperare i dati da una tabella con
dati di grandi dimensioni e scriverli in un file CSV.

00757593 In una distribuzione Cloud, è ora possibile eseguire la migrazione di
bots figlio utilizzando l'azione Migra Bot dal pacchetto Migrazione Bot.
In precedenza, i bots figlio non venivano migrati ma veniva comunque
visualizzato un messaggio di migrazione completata correttamente.

00731012, 00747385,
00746320

Se si installa la Control Room nella posizione predefinita in C:\ e si
configura la directory dei log in un'altra posizione (ad esempio, E:
\), i log WebCr vengono ora generati dinamicamente nella posizione
personalizzata.

00768318, 00760835 Non si verifica più un errore quando si tenta di acquisire oggetti
utilizzando AISense Recorder su qualsiasi versione di Windows che
non dispone del pacchetto di funzionalità multimediali predefinito.
In precedenza, AISense Recorder non evidenziava gli oggetti in una
pagina.

00737710 Nell'action Acquisisci del package Recorder, quando si seleziona
l'action Imposta testo e si immette una variabile stringa con un
ritardo impostato per ogni sequenza di tasti, l'output viene ora
visualizzato correttamente su una nuova riga per tutte le applicazioni
Microsoft. In precedenza, durante l'esecuzione del bot, l'output veniva
visualizzato su una sola riga quando veniva impostato un ritardo nella
Sequenza di tasti.

-- Se la distribuzione dei bots avviene utilizzando trigger di evento e si
installa l'Bot Agent su un dispositivo come utente non amministratore
per sé o per un utente Admin locale, l'Bot Agent viene ora aggiornato
automaticamente. Il dispositivo non verrà più visualizzato come
disconnesso in Control Room.

00782596 È ora possibile eseguire la migrazione dei bots di automazione dei
carichi di lavoro da Enterprise 11 a questa versione. Non viene più
visualizzato un messaggio di eccezione del protocollo client.

00743810, 00785703 È ora possibile mappare variabili con lettere maiuscole e minuscole
diverse tra bots padre e figlio quando vengono eseguiti bots dopo
la migrazione da Enterprise 11 a questa versione. For example, if
the variable name in Enterprise 11 is Var1 and the variable name
is changed to var1 after migration, you can map the variables and
continue to run the bots.
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-- Le distribuzioni di Bot sui dispositivi Bot Agent ora riescono
correttamente quando si chiude una finestra del terminale utilizzando
l'azione di chiusura Window dal pacchetto Window o la finestra
dell'Terminal Emulator viene chiusa manualmente.

00767587 È ora possibile eseguire bots dalla pagina Attività in corso. In
precedenza, i bots erano bloccati nello stato di Esecuzione in
sospeso e, di conseguenza, non venivano eseguiti altri bots. Era
necessario spostare manualmente i bots bloccati in questo stato nella
pagina Cronologia attività per eseguire gli altri bots in coda.

00789682, 00798933 È ora possibile eliminare, ripristinare o sospendere le automazioni
del carico di lavoro perché gli elementi di lavoro non sono più
bloccati nello stato Pronto. Inoltre, non viene più visualizzato il
seguente messaggio: L'elemento di lavoro non può essere
eliminato in questo stato.

00720471 Non si verifica più un errore quando si utilizza il pacchetto Recorder
per acquisire un oggetto ed eseguire l'action Clic sulle coordinate di
acquisizione. In precedenza, quando venivano acquisite le proprietà
dell'oggetto e se la barra di download era aperta in Google Chrome,
non era possibile acquisire le proprietà dell'oggetto nel browser.

00754651 Nell'action If del package If, quando si seleziona una condizione
dall'elenco Condizione e si trascina un'action all'interno dell'action If,
la condizione non viene più eliminata dall'elenco Condizione e l'action
non sparisce più dalla visualizzazione Elenco e Flusso.

00768354 Non si verifica più un errore quando si utilizza AISense Recorder nei
bots figlio quando li si esegue in un ciclo. In precedenza, quando
AISense Recorder veniva utilizzato in un bot figlio e il bot veniva
eseguito, i processi esterni non venivano terminati, causando
l'esaurimento della memoria del sistema.

-- In precedenza, durante l'esecuzione della migrazione del bot, il
processo inviava varie notifiche e-mail, talvolta multiple, a tutti gli
utenti esistenti della Control Room, anche se l'amministratore aveva
disattivato le notifiche e-mail. È stata ora aggiunta un'opzione per
consentire all'amministratore di disattivare le notifiche e-mail quando
vengono creati i dati dell'Credential Vault durante la migrazione del
bot.

00762368 In precedenza, quando i bots venivano migrati utilizzando processi di
Oracle Database con password contenenti il simbolo “@”, si verificava
un problema. Il problema è stato ora risolto e le password che
utilizzano il simbolo “@” sono ora supportate.

-- In precedenza, durante la migrazione, un bot padre veniva elaborato
correttamente anche se i bots figlio associati non esistevano. Questo
creava errori durante il runtime. In questa versione, se non esistono
bots figlio associati per il bot padre, un messaggio notifica all'utente
l'azione richiesta prima che la migrazione possa continuare.
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00762975 I Bots che utilizzavano l'azione Error Handling per acquisire le
schermate venivano modificati in modo errato e aggiunti come
file .PNG. I bots migrati non vengono più modificati e aggiunti in
questo modo.

00751496 Attended Bot Runner devices now show an improved time performance
when running bots on Microsoft Edge browser.

00753673 When you run a migrated bot that contains the Excel Advanced >
Delete cell > Specific cell option with comma-separated input cell
values such as A1, B1, the migrated bot now runs successfully and
displays the output correctly.

00736473 Risolto il problema per cui un bot migrato contenente l'azione Excel
avanzato > Apri non caricava i componenti aggiuntivi di Excel anche
quando era selezionata la casella di controllo Carica componenti
aggiuntivi. Ora i componenti aggiuntivi di Excel vengono caricati
correttamente.

00767917 È ora possibile eseguire bots con una coda su dispositivi per singolo
utente precedentemente configurati per più utenti.

00712719 Non si verifica più un errore quando si eseguono bots che contengono
actions dal pacchetto Terminal Emulator sul dispositivo. In precedenza
i bots non potevano essere eseguiti a causa di un problema di
sincronizzazione con il terminale.

00753121 Non si verifica più un errore quando si utilizza l'action Converti excel
in PDF del package Excel advanced per salvare un PDF convertito in
un'unità di rete condivisa.

00763746, 00773924 Quando si seleziona l'action Sequenze di tasti nel package Simulate
keystrokes e si immette un testo variabile o statico contenente
caratteri giapponesi a mezza larghezza, l'output ora visualizza i
caratteri giapponesi corretti. In precedenza, durante l'esecuzione del
bot, l'output visualizzava caratteri errati.

00774872, 00807106,
00824486

Quando si utilizza l'action Chiudi del package Browser per chiudere
l'ultima finestra del browser Chrome, l'ultima scheda di una finestra del
browser Chrome o tutti i browser Chrome, non si verifica più un errore
del bot. In precedenza, quando veniva utilizzata l'action Chiudi per
chiudere l'ultima finestra del browser Chrome, l'ultima scheda di una
finestra del browser Chrome o tutti i browser Chrome, l'esecuzione del
bot non riusciva perché il canale di comunicazione Chrome era stato
arrestato.

00762178 Quando si esegue la distribuzione di bots tramite RDP su dispositivi
utente non assistiti configurati per più utenti, non viene più acquisita
una schermata nera.

00800573, 00796393,
00804854

Quando si seleziona un'esecuzione come utente per distribuire un bot,
è possibile aggiungere un utente Bot Runner dall'elenco di Bot Runners
selezionati all'elenco di Bot Runners disponibili nella pagina Esegui il
bot ora.
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00744929 Quando vengono immesse credenziali Git errate, le credenziali
vengono ora nascoste e non registrate nel file WebCR_Commons.log.
In precedenza, le credenziali di accesso Git non corrette venivano
registrate e non nascoste nel file di registro.

00751304 Il modello di errore nei documenti di Swagger è ora aggiornato per
visualizzare tutti i campi visualizzati nel corpo della risposta dell'API. In
precedenza, c'era una mancata corrispondenza tra i campi visualizzati
nel corpo della risposta dell'API e il modello di errore nei documenti di
Swagger.

00763398 Non si verifica più un errore quando vengono aperti più file Excel
e si utilizza l'action Esegui macro nel package Excel advanced. In
precedenza, veniva visualizzato un errore quando veniva eseguita una
macro con più sessioni.

00759183 L'action Apri del package File apre ora qualsiasi file utilizzando
l'applicazione predefinita impostata dall'utente. Ad esempio, se
Microsoft Paint è impostato come applicazione predefinita per tutti i file
.jpg, l'azione apre questi file senza errori. In precedenza, l'esecuzione
del bot non riusciva per un errore.

00750185 Non si verifica più un errore quando si esegue un bot Enterprise 11
migrato contenente il comando Object Cloning anche se contiene
alcuni caratteri Unicode 8964 in alcune delle sue proprietà. Il bot
acquisisce ora gli oggetti dopo la migrazione senza alcun errore.
In precedenza, il bot non riusciva ad acquisire gli oggetti dopo la
migrazione se contenenti caratteri Unicode nelle relative proprietà.

00774091 Tutte le proprietà dell'oggetto del comando Object Cloning vengono
ora migrate senza errori. In precedenza, l'esecuzione del bot non
riusciva per un errore perché le proprietà dell'ID HTML e del nome
HTML venivano modificate dopo la migrazione.

00796322, 00823082 Quando si inserisce una variabile come parametro in qualsiasi action
di un package, si aggiunge del testo a questa variabile, si salva il bot
e quindi si modifica il nome della variabile dall'elenco delle variabili, i
caratteri aggiuntivi aggiunti alla variabile non vengono più eliminati.

00731066 L'action Acquisisci nel package Registratore ora funziona
correttamente e non si verifica più alcun ritardo durante la
creazione e l'esecuzione di nuovi bots per estrarre dati da un
comando DataGridView in determinate applicazioni di automazione
dell'interfaccia utente.

00784177 Non viene più visualizzato un errore di distribuzione del bot quando
si modifica e si esegue un bot utilizzando Esegui il bot ora dall'Bot
editor di una Cloud Control Room.

00782307, 00787807,
00811404, 00788178

Le distribuzioni di Bot non sono più bloccate in una coda e ora
visualizzano l'errore Scelto in fase di esecuzione dopo
l'aggiornamento di Automation 360 On-Premises dalla versione
precedente a questa versione.
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00786786, 00806775 È ora possibile acquisire un singolo oggetto utilizzando un registratore
dal browser Google Chrome e non viene più visualizzato il seguente
messaggio: Errore nell'esecuzione della singola
acquisizione.

00780202, 00798826,
00808779

Quando si esegue la distribuzione dei bots tramite RDP su dispositivi
utente non assistiti configurati per più utenti e si imposta la risoluzione
dello schermo RDP su 1366x768, la risoluzione non cambia più in
1368x768 durante l'esecuzione del bot.

00769647, 00767674,
00773115, 00777239,
00778972, 00777752,
00792839, 00804603,
00806606, 00815687,
00829496

La pagina Visualizza cronologia attività ora mostra i dettagli di
esecuzione corretti di data e ora di inizio per i bots che danno esito
negativo durante l'esecuzione.

Limitazioni

Se si configura un archivio chiave esterno in Integrazione dell'archivio chiave esterno e si
seleziona la modalità Autenticazione SQL per l'autenticazione del database nella pagina del
programma di installazione di Windows Server di database per installare la Control Room (On-
Premises), l'installazione fallisce e viene mostrato il seguente messaggio di errore: Impossibile
creare le tabelle del database della Control Room.
Soluzione: aggiungi le credenziali del database nell'archivio chiave esterno e utilizza queste
credenziali per la configurazione del database.

The Task bots runs metric on the Home dashboard page of the Control Room displays the count
as zero even if you have run bots from the same Control Room.

(ID caso Service Cloud: 00837271) Se si sta migrando da Enterprise 11 con un database che ha
una grande quantità di dati d'archivio, l'installazione potrebbe non riuscire. Questo problema si
verifica perché l'aggiornamento di Liquibase per alcune query SQL non viene completato durante la
migrazione.
Soluzione: contatta l'assistenza Automation Anywhere.

When you are installing the Bot Agent, if you run out of disk space and click OK on the Out of
disk space window, the Bot Agent installation wizard might display the previous installer windows.
Soluzione: In the Setup type window, click Cancel and relaunch the Bot Agent installation
wizard.

(ID caso Service Cloud: 01021889) In questa versione, quando si pianifica o si distribuisce un bot
dalla Control Room, non si riceverà alcuna e-mail di notifica se il bot non riesce ad essere eseguito.
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(ID caso Service Cloud: 00780635, 00791587, 00795559, 00795632, 00797130, 00797113,
00791783, 00765770, 00826805, 01859661) When you update from the previous release,
schedules disappear from Control Room instances configured on a single-node or multi-node
environment. In some cases, after the update, previously deactivated schedules disappear and are
reactivated automatically.
Soluzione: Divide large schedules into smaller schedules or reduce the schedule frequency.
• Divide large scheduled automations into smaller schedules of two hours each. For example,

divide an automation schedule that runs for a 12-hour period, such as 9 AM to 9 PM daily, into
two-hour intervals, such as 9 AM to 10:59 AM, 11:00 AM to 12:59 PM, and 1:00 PM to 2:59 PM.

• Reduce the schedule frequency to 10 minutes.

La migrazione di MetaBots Enterprise 10 con variabile di tipo password con valore nullo non è
ancora supportata. Per eseguire correttamente la migrazione, fornire un valore predefinito alla
variabile password quando si creano i MetaBots in Enterprise 10.

Quando si tenta di accedere alla Control Room configurata con Active Directory, l'utilizzo
dell'opzione Accedi con Windows non è attualmente supportato in questa versione. La selezione
di questa opzione può generare un errore java.lang.NoSuchMethodError.
Azione consigliata: Immettere direttamente le credenziali del dominio.

(ID caso Service Cloud: 00831886) Come Bot Creator, non puoi eseguire attività bot tramite il
processo AARI. Anche se le attività umane sembrano a posto, la pagina Attività mostra lo stato In
corso e appare bloccata sull'azione In attesa dell'utente e/o del dispositivo.
Soluzione: Rimuovere licenza process discovery - registratore dall'utente Bot Creator AARI.
Consultare AARI process discovery license assignment per ulteriori informazioni.

Non è possibile utilizzare l'opzione Sessione globale per condividere una sessione di Microsoft
Excel utilizzando il package Excel advanced con il package Loop.
Soluzione alternativa: Utilizzare l'action Ottieni più celle e salva i dati in una variabile Tabella
dati. Poi, utilizzare il package Loop con l'opzione Tabella dati selezionata.

Il processo di migrazione esegue correttamente la migrazione di bots che contengono parentesi o []
ma il processo non riesce quando si esegue nuovamente la migrazione dello stesso bots per migrare
le modifiche delta anche quando è selezionata l'opzione di sovrascrittura.
Soluzione: Eliminare da Automation 360 i bots esistenti che contengono parentesi o [] prima di
eseguirne di nuovo la migrazione.

Gli utenti con il ruolo Amministratore AAE_Bot Migration non sono in grado di eseguire i bots
migrati perché le autorizzazioni Esegui i miei bot e Crea cartelle non sono disponibili per questo
ruolo. Di conseguenza, questi utenti possono avviare il processo di migrazione, convertire i bots ma
non eseguire i bots migrati.
Soluzione: Creare un ruolo personalizzato con le autorizzazioni Esegui i miei bot e Crea
cartelle e assegnare questo ruolo agli utenti con il ruolo Amministratore AAE_Bot Migration.

Quando MetaBots Enterprise 11 che utilizzano una DLL che restituisce una matrice bidimensionale
di tipo singolo come output e memorizza il valore in un file utilizzando il comando Log To File
vengono migrati come TaskBots a Automation 360, questi TaskBots riscontrano un errore quando
vengono eseguiti.

I bots migrati utilizzati per le attività automatiche mediante RDP riscontrano un errore quando il DPI
del dispositivo remoto è diverso dal dispositivo corrente.
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Limitazioni

Gli utenti della Control Room appena creati su Windows per VM On-Premises Google Cloud Platform
non possono modificare la propria password. L'opzione delle domande di sicurezza non è disponibile
nella schermata Cambia password e, di conseguenza, la Control Room visualizza un errore
quando si tenta di salvare la password.
Soluzione: aggiornare la pagina e modifica nuovamente la password.

(ID caso Service Cloud: 00770816) Quando si effettua la connessione a un server Exchange
Web Services, è necessario disattivare l'autenticazione multifattore (MFA), inclusi tutti i criteri
di protezione a livello aziendale in cui è possibile attivare l'autenticazione multifattore. Se
l'autenticazione a più fattori non viene disattivata completamente, gli utenti potrebbero riscontrare
errori di connessione e/o di autorizzazione.

Automation 360 non supporta la versione Kibana in Elasticsearch per la quale viene visualizzato un
errore di escalation dei privilegi nel report Black Duck.

L'Bot Agent non viene aggiornato automaticamente da una versione precedente a questa quando
si eseguono diverse operazioni contemporaneamente, come l'esecuzione di bots, la configurazione
delle impostazioni dispositivi nella Control Room e l'aggiornamento della Control Room.
Soluzione: Riavviare l'Bot Agent da Gestione attività.

Un file non viene eliminato quando si esegue il bot con la seguente sequenza di actions:
1. You use the CSV/TXT > Open action to open a .csv file.
2. Si utilizza un'action Ciclo all'interno di un'altra action Ciclo per recuperare i valori dal file .csv.
3. You use the CSV/TXT > Close action to close the file.

In questo caso, tutte le actions utilizzano la stessa sessione predefinita.
4. You use the File > Delete action to delete the file.

Il problema (il file non viene eliminato) si verifica perché il bot non riesce a chiudere la sessione
predefinita.

L'esecuzione del Bot può non riuscire per un errore quando si esegue il bot con la seguente
sequenza di actions all'interno di un ciclo:
1. You use the Browser > Open action to open a window.
2. You use the Recorder > Capture action to capture required objects on the window.
3. You use the Browser > Close action to close the window.

Soluzione: Use the Window > Close action to close the window instead.

If you update the device information from the Administration > Settings > Devices page, only
the first update is captured in the Audit Log page. Gli aggiornamenti successivi al dispositivo non
vengono acquisiti.

Quando si registra un nuovo dispositivo utente Bot Agent dall'editor di bot dopo la creazione e
l'esecuzione di un bot, viene visualizzato a intermittenza il seguente messaggio: Il dispositivo
è disconnesso o deve essere aggiornato.
Soluzione: Fare clic su Esegui per distribuire il bot sul nuovo dispositivo utente Bot Agent.

Quando si utilizza il Universal Recorder per registrare più schede in un'applicazione SAP, l'action
Imposta testo nel controllo Client di SAP non funziona perché attualmente non è supportata.
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Limitazioni

When multiple users check in their bots simultaneously, some of the check-ins fail although Git is
not corrupted and no data is lost.

When you use the 2.3.0-20210806-215200 version of the Recorder package to capture any control
using HTML technology in Google Chrome or Microsoft Edge Chromium browser and run the bot,
the bot might fail with the following error message: Unable to find control. Criteri di
ricerca non corrispondenti

Soluzione: Use the 2.2.0-20210722-211132 version of the Recorder package instead.

When you try to automate any process in a Java application that is using version 11.0.8 of
AdoptOpenJDK, the Recorder might not be able to capture the drop-down elements on the
application.

AARI (Automation Anywhere Robotic Interface)

Novità

Supporto delle variabili di output nell'editor di processo
La sezione Variabili di output nell'editor di processo consente di creare una variabile definita
dall'utente che può essere impostata come output per qualsiasi processo. In questo modo è
possibile passare l'output dal processo figlio (secondario), chiamato in Attività del processo, al
processo padre (principale).
Use an Output variable alla pagina 2144

Selezionare l'input elemento file supportato per l'azione Crea una richiesta
L'azione Crea una richiesta nel pacchetto Web AARI ora supporta il passaggio di input nei
moduli di creazione della richiesta all'elemento Seleziona file. È ora possibile utilizzare bots per
creare una richiesta e caricare o scaricare file come input con l'elemento Seleziona file. Questi
file di input vengono caricati nel servizio di archiviazione per essere disponibili per un'ulteriore
elaborazione nella richiesta.

Visualizzazione dettagli nella pagina Attività
Per una migliore gestione delle attività, la nuova opzione Visualizzazione dettagli nella pagina
Attività fornisce informazioni più dettagliate sulle singole attività. La visualizzazione dei dettagli
mostra in anteprima ogni attività nella rispettiva pagina di visualizzazione delle richieste senza
aprire un'altra pagina, il che permette di organizzare e far corrispondere le attività alle richieste
disponibili. Gli utenti possono interagire anche con le proprie attività.
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Novità

Supporto aggiuntivo per i trigger interfaccia su Google Chrome
È possibile utilizzare le seguenti actions aggiuntive per i trigger interfaccia sul browser Google
Chrome durante il runtime del bot:
• Elemento Collegamento ipertestuale: fare clic sulle azioni Imposta come attivo o

Disattivato
• Elemento Casella di controllo: selezionare o deselezionare le azioni Imposta come attivo,

Disattivato o Selezione modificata
• Elemento Pulsante di opzione: selezionare o deselezionare le azioni Imposta come attivo,

Disattivato o Selezione modificata

Add an interface trigger alla pagina 2213

Cosa è cambiato

Dimensione del carattere mantenuta durante il runtime del bot
Quando si crea un modulo, la dimensione del carattere selezionata nel menu a discesa
Formattazione > Dimensioni carattere viene mantenuta nel modulo durante il runtime del bot.

Opzione Annulla nella pagina di configurazione del processo e del team
Quando un utente modifica un processo o un team nelle pagine Configurazione del processo e
Configurazione del team, l'opzione Annulla sostituisce l'opzione X precedente per fornire una
maggiore chiarezza all'utente per annullare la pagina corrente.

Correzioni

ID caso Service Cloud Descrizione

00781358 È ora possibile aggiungere a un processo bots con variabili di tabella
che non hanno un valore predefinito senza riscontrare errori.

00791703 Quando si usa l'icona della barra delle applicazioni del desktop per
aprire AARI Assistant, i file dipendenti non vengono più visualizzati
insieme all'applicazione.

-- Nell'editor dei processi, l'opzione Vai a mostra ora le opzioni Filtra
attività e Attività del processo.

-- Quando si immettono dati in un modulo del processo che contiene
un collegamento ipertestuale, i dati del processo non vengono più
ignorati e ora funzionano correttamente.

-- Quando si utilizza Attività del processo nell'editor dei processi,
è ora possibile utilizzare l'opzione Cartella pubblica nel campo
Seleziona un file di processo.

-- In Attività del bot e Attività umana, quando si seleziona una
casella, l'input viene ora selezionato con precisione.

-- La pagina Richieste viene ora aggiornata correttamente con gli
eventi di richiesta più recenti (ad esempio il completamento delle
attività) per gli utenti con una licenza assistita.
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Correzioni

ID caso Service Cloud Descrizione

-- Quando si effettua l'aggiornamento a questa versione, un pianificatore
integrato ora controlla periodicamente eventuali dispositivi disconnessi
o temporanei e cancella queste voci.

-- Quando si apre un modulo nella cartella pubblica, non è ora possibile
modificarlo cambiando il termine Visualizza in Modifica nell'URL.

-- Quando un utente accede ad AARI Assistant, tutti i trigger associati a
tale nome utente sono ora disponibili.

Limitazioni

Gli utenti non possono modificare un modulo o un processo in uno spazio di lavoro pubblico,
devono eseguirne l'estrazione per poterlo modificare in uno spazio di lavoro privato. Tuttavia,
quando gli utenti tentano di modificare un modulo o un processo in uno spazio di lavoro privato,
ricevono un messaggio di errore Accesso negato a causa del mancato aggiornamento della cache.
Soluzione: Navigate to the your private workspace, refresh the page to clear the cache, then edit
your form or process.

An AARI user with the AAE_Robotic Interface User license who is not apart of an assigned team
can view all requests and tasks from other teams in the web interface. However, when the user
attempts to access a request or task, they are prompted with an error message.

Quando un modulo viene aperto durante il runtime del bot, l'attivazione automatica del primo
elemento del modulo viene persa. Ad esempio, ipotizziamo che il modulo A abbia vari elementi e
che un elemento Casella di testo denominato Nome sia il primo elemento. Quando il modulo A
viene aperto durante il runtime del bot, l'elemento Nome non è attivo e non è possibile immettere
alcun valore.
Soluzione: Quando un modulo viene aperto durante il runtime del bot, fare clic sull'elemento del
modulo per immettere o modificare il valore.

Quando si accede all'interfaccia Web come amministratore, per alcune lingue il testo tradotto nel
riquadro di navigazione sinistro è troncato (non visualizzato completamente).
Soluzione: Passare il mouse sulla voce di menu per visualizzare la descrizione comandi, che
visualizza il testo completamente tradotto.

Nell'istanza Google Cloud Platform dell'interfaccia AARI on the web, quando si apre una richiesta
che contiene file caricati in precedenza, potrebbe verificarsi un errore intermittente durante il
download dei file.
Soluzione: Riprovare a scaricare il file.

Se un modulo ha un elemento tabella e si utilizza l'azione Imposta del pacchetto Moduli interattivi
durante il runtime del bot, i valori non vengono applicati all'elemento tabella.

Se è stato selezionato un trigger di azione come Valore modificato per un elemento Elenco a
discesa all'interno di un ciclo di trigger, qualsiasi evento associato viene attivato durante il runtime
del bot anche quando è presente un'azione Ripristina.

In una configurazione SDS, quando si crea una richiesta di caricamento di un file, il caricamento
non riesce e viene visualizzato un messaggio di errore relativo a una Eccezione di token di
sicurezza non valido.
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Limitazioni

L'opzione Sovrascrivi variabile di output nell'endpoint Termina processo non è attualmente
funzionale per gli utenti per sovrascrivere una definizione di variabile.

Discovery Bot

Novità

Visualizzazione di gruppi di fasi
Quando si esamina una visualizzazione del processo, è ora possibile utilizzare l'opzione o l'icona
del gruppo per visualizzare gruppi di fasi che appartengono all'azione di livello primario e all'azione
di livello secondario (e alle azioni a livello di sottogruppo) utilizzate durante la sessione di
registrazione.
Utilizzare l'icona del gruppo per decidere quali gruppi di fasi selezionare per un'attività che si
desidera automatizzare. Ad esempio, un'azione di livello principale visualizza Microsoft Outlook,
un'azione di livello secondario visualizza la notifica della posta di Outlook e le azioni di livello
sottogruppo visualizzano termini quali e-mail - Aggiungi a, E-mail – Aggiungi oggetto.
Create a process view with branches and opportunities

Uso dell'opzione Dinamica per le viste generate dal sistema
You can now use the Dynamic option from the Model options to view recordings where groups of
steps display a set of repeating patterns that belong to the same application or same primary level
action used during the recording session.
Utilizzare questa opzione per decidere il contesto del processo o dell'attività che si desidera
automatizzare. I gruppi di fasi etichettati appartengono ad applicazioni supportate come Microsoft
(Excel, Outlook e Blocco note), Blocco note++, editor di testo, la maggior parte dei casi di utilizzo
delle finestre e la funzionalità del browser Chrome.
Create a process view with branches and opportunities

Miglioramenti al documento PDD Word
Il documento PDD Word ora include un diagramma di flusso della registrazione dei processi e il
tempo di ogni singola fase in ore, minuti e secondi.
Review opportunities and convert to

Correzioni

ID caso Service Cloud Descrizione

-- The Control Room installer for Red Hat
Enterprise Linux (version 7.7 or 7.9) now
includes the Discovery Bot package. Previously,
you had to log in to the Control Room as admin,
select Manage > Package > Upload, and
upload the Discovery Bot package.
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Limitazioni

In un ambiente Linux, quando si registra un processo utilizzando il registratore Discovery Bot, la
finestra del registratore si apre per 4 secondi e poi scompare. L'errore si verifica perché la cartella
ProcessDiscovery non è presente nella seguente directory: /var/automationanywhere/
enterprise/appdata/Server Files/.
Soluzione: Per creare manualmente una cartella ProcessDiscovery vuota e fornire l'accesso in
scrittura alla cartella, procedere come segue:
1. Accedere al seguente percorso nella directory Control Room:

a. Se è stato eseguito l'aggiornamento da una versione precedente a v.22, accedere a /opt/
automationanywhere/enterprise/appdata/Server Files

b. Se si esegue una nuova installazione di v.22, accedere a /opt/automationanywhere/
automation360/appdata/Server Files

2. Eseguire il comando sudo mkdir ProcessDiscovery per creare una cartella vuota per
ProcessDiscovery nella directory della Control Room specificata.

3. Eseguire il comando seguente per fornire l'autorizzazione di lettura e scrittura richiesta per la
cartella ProcessDiscovery appena creata:
a. sudo chown -R crkernel:controlroom ProcessDiscovery/

b. sudo chmod -R 775 ProcessDiscovery/

When you upgrade to A360 v.22, you might receive multiple email notifications about the PDD
generated in A360 v.21.

Quando aggiungi rami a sinistra e a destra del ramo principale, la sezione del diagramma di flusso
Registrazione del PDD potrebbe non acquisire l'intero flusso di lavoro del processo, compresi tutti i
rami.

IQ Bot

Novità

Integrazione dei moduli standard di IQ Bot con IQ Bot Extraction
È ora possibile utilizzare il package IQ Bot Extraction per l'estrazione dei dati dai documenti dei
moduli standard.
Utilizzo dell'action Elabora documenti IQ Bot alla pagina 1661

Soglia di attendibilità applicabile all'istanza di apprendimento dei moduli standard
Per un'istanza di apprendimento di moduli standard, se il valore di Soglia di attendibilità utente
impostato non corrisponde a nessun campo, il documento viene spostato al Validator e viene
visualizzata un'icona di notifica. Questo aggiornamento consente ora di convalidare il documento
per l'istanza di apprendimento e anche di salvarlo.

© 2023 Automation Anywhere. All rights reserved.     378



    Automation Anywhere - Learn

Novità

Motori OCR aggiuntivi per il package IQ Bot Extraction
Oltre ai motori OCR esistenti, il package IQ Bot Extraction ora supporta i seguenti motori OCR:
• Microsoft Azure 2.0
• Google Vision API

IQ Bot Extraction package alla pagina 1654

Esportazione dei dati del dashboard di IQ Bot
A user with the AAE_IQ Bot Admin role can now export the following data from the dashboard to
a CSV file using the Export icon:
• Documenti elaborati
• Pagine caricate
• Elaborazione interamente automatizzata
• Precisione

Il file CSV viene salvato nella cartella Download locale.

Supporto IQ Bot per certificati autofirmati
Puoi creare un certificato autofirmato con il nome alternativo del soggetto (Subject Alternative
Name, SAN) quando desideri utilizzare un certificato SSL per più domini.
Creazione di un certificato autofirmato con il nome alternativo del soggetto alla pagina 1092

Cosa è cambiato

Il package IQ Bot supporta le impostazioni del server proxy esterno (ID caso Service
Cloud: 00727414, 00725235, 00757568, 00753560, 00753560, 00786609)
Le actions Scarica tutti i documenti e Carica documento nel package IQ Bot ora supportano le
impostazioni del server proxy esterno.

Aggiornamento della libreria Python di IQ Bot (ID caso Service Cloud: 00756943, 00791511)
IQ Bot ora utilizza Python versione 3.9.5 per l'estrazione dei dati.

Cosa è obsoleto

package IQ Bot [Local Device]
Il package IQ Bot [Local Device] di IQ Bot è obsoleto in questo Automation 360 v.22 (Build 10526).
Utilizzare invece il package IQ Bot Extraction, che fornisce le stesse funzionalità del package IQ Bot
[Local Device], insieme a ulteriori miglioramenti.
IQ Bot [Local Device] package replaced by IQ Bot Extraction package (A-People login required)

Nota:  Prima di utilizzare il package IQ Bot Extraction, aggiornare i bots associati al package IQ Bot
[Local Device] e ristrutturare le cartelle di output.

IQ Bot Extraction package alla pagina 1654
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Correzioni

ID caso Service Cloud Descrizione

-- Se si elimina un file .csv dalla cartella Operazioni riuscite, è ora
possibile scaricare i file rimanenti da tale cartella.

-- Quando si utilizza il package IQ Bot Extraction per l'elaborazione di un
set di documenti di grandi dimensioni, non si verificano più problemi di
elaborazione dei documenti con Bot Agent.

-- Se è stato utilizzato un valore errato nel campo ProviderVersion
durante il caricamento delle configurazioni dei moduli standard su IQ
Bot, viene visualizzata una notifica di errore quando si seleziona questa
configurazione durante la creazione di un'istanza di apprendimento dei
moduli standard.

00806805 È possibile ora importare un'istanza di apprendimento utilizzando l'Utilità
di migrazione poiché il messaggio di errore Gruppo non valido è
stato risolto.

-- Durante la creazione di un'istanza di apprendimento utilizzando moduli
standard, tutti i modelli pre-formati disponibili sono ora elencati nel
menu a discesa Seleziona modello.

00703856 IQ Bot ora estrae correttamente le righe di tabella con valori numerici
anche quando sono racchiuse tra parentesi.

-- L'API di download file ora restituisce una risposta JSON formattata
correttamente con due punti (:) che separano le coppie chiave-valore.

00694656 IQ Bot ora estrae correttamente i valori dai documenti cui sono stati
aggiunti nuovi campi tabella dopo la formazione.

00636887 Viene visualizzata una notifica di errore se si caricano documenti con
nomi di file più lunghi di 150 caratteri asiatici nell'ambiente di gestione
temporanea.

Nota:  Questo non è applicabile a un ambiente di produzione.

-- La query dei dati cloud di IQ Bot è ora ottimizzata per evitare il
sovraccarico del servizio di database relazionale Amazon.

00782994 Quando si utilizza Migration Utility per spostare un'istanza di
apprendimento tra ambienti, i dati non classificati non vengono più
esportati.

00747137 Ora puoi importare istanze di apprendimento usando la funzionalità
Utilità di migrazione senza alcun problema.

Limitazioni

The value displayed in the My totals > Accuracy field sometimes does not match the value in the
My learning instances > Field accuracy for the available learning instances.

Se si tenta di importare un'istanza di apprendimento in un ambiente IQ Bot con un'istanza di
apprendimento eliminata con lo stesso nome, viene visualizzato il messaggio anche se l'istanza di
apprendimento non è stata importata: Processo di importazione avviato
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Limitazioni

If you access IQ Bot without the correct permissions, they are redirected to an Access denied
page, where the back button does not work.
Soluzione: Chiudere la scheda corrente e aprire la Control Room.

Quando si seleziona il dominio Altro nella pagina di creazione dell'istanza di apprendimento,
le descrizioni dei comandi per i campi della tabella e del modulo indicano che tali campi sono
opzionali. Tuttavia, questi campi sono necessari per creare un'istanza di apprendimento.

A volte l'installazione di IQ Bot non va a buon fine e viene visualizzato il seguente messaggio:
Impossibile aggiornare il DB: -1. Quando si verifica questo problema, riprovare
l'installazione.

(ID caso Service Cloud: 01016516, 00757943, 00787404, 00788421, 00807528, 00822941,
01018972) If you add multiple ABBY OCR based commands (such as IQ Bot Pre-processor, IQ Bot
Classifier, AISense Recorder, OCR) in a single bot, an error message is displayed when you run the
bot.
Soluzione: Ensure that you do not add multiple commands in a single bot.

(ID caso Service Cloud: 01063054)You cannot import a learning instance with a long name (>50
characters) because IQ Bot only supports up to 50 characters in the Label field.

If you use the Process documents action from IQ Bot Extraction package to upload documents,
the validation rules from the default the validation group that you set are not applied. As a result,
the failed documents are not classified into any of the existing groups and are moved to Validator.

Nella Community Edition IQ Bot, quando si utilizza un OCR Cloud per creare un'istanza di
apprendimento, se si utilizza l'action Elabora documento di IQ Bot dal package IQ Bot Extraction,
i valori delle fatture o dei documenti caricati non vengono elaborati correttamente.
Soluzione: Se si utilizza il OCR Cloud per creare un'istanza di apprendimento, utilizzare l'action
Carica documento di IQ Bot dal package IQ Bot.

After you train a bot and click Save and go to next group, the system fails to load the next
group. Instead, it reloads the same group.
Soluzione: eseguire i passaggi seguenti:
1. Aggiorna la pagina.
2. Navigate to Learning Instances and click Bots to edit the Learning Instances.

System identified regions are not generated when a non-English filename is uploaded using the
Invoice domain and processed with the AutoExtract command.
Soluzione: To process the document, convert the non-English filename to English characters.
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Bot Insight

Correzioni

ID caso Service Cloud Descrizione

00788583 Nella scheda Profilo, quando si modifica, salva e genera un
dashboard aziendale e il dashboard non viene salvato, la descrizione
del messaggio di errore viene ora tradotta correttamente in lingua
cinese. In precedenza, se si verificava un errore quando si salvavano
le modifiche nella scheda Profilo del dashboard Azienda, la
descrizione del messaggio di errore mostrava un testo confuso.

00729920 Quando si esegue la migrazione di un'attività da un ambiente di
origine (UAT) a un ambiente di destinazione (produzione), una copia
del dashboard pubblicato non viene più eliminata dall'ambiente di
origine.

00742260 È ora possibile esportare i dati da dashboard operativi o
personalizzati dopo aver applicato una variabile non metrica nel
filtro. In precedenza, i dati non venivano esportati quando si passava
da un tipo di grafico all'altro.

00738228 Non vengono più creati più dashboard per un TaskBot quando si
aggiorna ed esegue un bot sottoposto a check-out dall'area di lavoro
pubblica. In precedenza, quando un bot veniva eseguito dopo un
aggiornamento, venivano creati più dashboard.

00757992 Un utente con licenza di Bot Creator può ora accedere a
tutti i dashboard Bot Insight (schede Operazioni e Attività)
indipendentemente dal ruolo assegnato. In precedenza, se
l'utente disponeva della licenza di Bot Creator con il ruolo di
Amministratore AARI, non poteva accedere a questi dashboard.

Limitazioni

(ID caso Service Cloud: 00733555, 01912503) In a dashboard, the data labels in the pie chart
overlap if it contains many slices. As a result, the labels in pie chart are not clear and shown only
when you hover over the slices.
Soluzione: To view the data labels in a pie chart in clear and readable format, export the
dashboard data to Excel file.

Nota:  Due to a limitation within the third-party recharts library, you might observe labels
overlapping issue with data in downloaded PDF as well.

Importante:  Per informazioni sui pacchetti supportati da questa versione, vedi View package versions
available in the Control Room alla pagina 2009.

Note sulla versione Automation 360 v.21
Data di rilascio:9 giugno 2021

© 2023 Automation Anywhere. All rights reserved.     382



    Automation Anywhere - Learn

Riesaminate le novità e le modifiche apportate e le correzioni e le limitazioni della Automation 360 versione
v.21. Automation 360 (Cloud e On-Premises) è su Build 9664. Automation 360 IQ Bot Cloud è sulla Build
9664 e On-Premises è sulla Build 9642.

Aggiornamenti e rilascio di patch

Abbiamo aggiornato Automation 360 Build 9664 (Cloud e On-Premises) per le seguenti correzioni:
• Le distribuzioni dei processi che contengono moduli con tabelle, caselle di controllo o caselle di testo

vuote non riescono dopo l'aggiornamento della build AARI Cloud dalla versione precedente alla versione
corrente (ID caso Service Cloud: 00788255).

• Il layout della pagina di visualizzazione richiesta cambia quando viene selezionata una lingua diversa
dall'inglese (ID caso Service Cloud: 00772925).

• Il rendering di caratteri dei messaggi di avviso negli editor di processo risulta distorto a causa della
codifica UTF-8 mancante (ID caso Service Cloud: 00781891, 00784947).

• Gli utenti (con licenza assistita) non vengono reindirizzati all'applicazione AARI Assistant a causa degli
utenti (senza licenza assistita) che hanno tentato in precedenza di connettersi all'applicazione AARI
Assistant sullo stesso dispositivo.

• Non è possibile acquisire azioni con sequenze di tasti su un'applicazione utilizzando il registratore
Universal (ID caso Service Cloud: 00785310).

• File mancanti nella cartella delle risorse incorporate causano problemi nell'utilizzo del pacchetto
Registratore (ID caso Service Cloud: 00767315, 00777786, 00775209, 00788523, 00797261, 00795511,
00785246).

• Le distribuzioni di Bot si bloccano in una coda dopo l'aggiornamento di Automation 360 Cloud dalla
versione precedente a questa versione (ID caso Service Cloud: 00784333, 00784890, 00784382,
00784338).

• I bots clonati perdono la loro dipendenza dopo il check-in (ID caso Service Cloud: 00780756).
• La durata della registrazione non veniva aggiornata correttamente in Ciclo del processo sulla

scheda del processo e le fasi registrate non venivano acquisite dal registratore (ID caso Service Cloud:
00790884, 00781022).

• Migrazione
11.x e 10.x | solo 11.x | solo 10.x

• RPA Workspace
Novità | Cosa è cambiato | Correzioni | Limiti

• AARI
Novità | Cosa è cambiato | Correzioni | Limiti

• Discovery Bot
Novità | Correzioni | Limiti

• IQ Bot
Novità | Cosa è cambiato | Correzioni | Limiti

Aggiornamento a questa versione

È possibile eseguire l'aggiornamento alla versione v.21 di Automation 360 dalle tre precedenti versioni
(ovvero dalle versioni n-3, dove n si riferisce alla versione più recente). Le seguenti versioni precedenti
sono certificate per l'aggiornamento a questa versione:
• v.20 (Build 8815)
• v.19 (Build 8147, 8145, 8122, 8098)
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• v.18 (Build 7560)

È possibile aggiornare direttamente alla v.21 da una qualsiasi di queste build. Per i dettagli su come
eseguire l'aggiornamento, consultare Aggiornamento alla versione di Automation 360 più recente alla pagina
1063.

Nota:  Se non si utilizza una versione n−3 di Automation 360, eseguire l'aggiornamento a una delle tre
versioni certificate prima di eseguire l'aggiornamento a questa versione.

Importante:  This release includes a required update to your . Ensure that you complete the update to
continue with your automation activities when upgrading from a previous release to this release.
Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina
1043

To verify which  version is compatible with this release, see Compatibility with release builds alla pagina
1026.
Miglioramento delle estensioni del browser: Alle estensioni di Automation 360 per Google Chrome
(versione 1.2.0.0), Microsoft Edge (versione 1.2.0.0) e Mozilla Firefox (versione 1.2.0.2) sono stati
apportati i seguenti miglioramenti:
• Supporto di pulsanti HTML e azioni di testo nei Interface trigger
• Miglioramento dei criteri di ricerca predefiniti per caselle di testo e caselle di controllo che utilizzano il

pacchetto Recorder.
• Correzioni all'acquisizione di oggetti con caratteri non validi in XML mediante il pacchetto Recorder.
• Correzioni al registratore Discovery Bot con pagina di ricerca del browser predefinita (Google Chrome).

Funzionalità di migrazione

Enterprise 11 e Enterprise 10 funzionalità

Nuovo ruolo di sistema per eseguire la migrazione
Assegna il ruolo di sistema Amministratore AAE_Bot Migration all'utente che eseguirà la
migrazione. Questo ruolo contiene tutte le autorizzazioni necessarie per visualizzare e gestire
il processo di migrazione di bot. Utilizzando questo ruolo si elimina la necessità di creare
manualmente ruoli personalizzati, selezionare le autorizzazioni richieste e assegnarle agli utenti che
eseguono la migrazione.

Finestra di runtime bot potenziata
Quando si esegue la migrazione dei bots utilizzando Bot Migration Wizard, la finestra runtime bot
mostra ora il nome del file bot Enterprise 11 o Enterprise 10 attualmente migrato.

È ora possibile eseguire la migrazione dei bots con le impostazioni Apri la pagina Web in una
nuova finestra e Apri la pagina Web in una finestra esistente.

È ora possibile eseguire la migrazione dei bots Enterprise 11 e Enterprise 10 con più versioni di una
DLL.
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Funzionalità esclusive di Enterprise 11

Schermate di MetaBot: Miglioramenti agli oggetti personalizzati e alla modalità di
riproduzione
• Gli oggetti personalizzati nella modalità di riproduzione delle immagini sono ora completamente

supportati.
• Gli oggetti collegati vengono ora acquisiti.

Opzione Nascondi/Mostra migliorata in Control Room
Per i bots disponibili in Control Room (cartella I miei bot), è disponibile un filtro per nascondere
o mostrare i file .mbot e .atmx più vecchi visualizzati nella finestra.

Valori globali per SAP
Il processo di migrazione crea i valori globali JcoDllPath e JcoJarPath della stringa del tipo, per
supportare la migrazione di BAPI SAP.

Funzionalità dell'action Database avanzate
L'action Database supporta ora la connessione ai database Oracle tramite SID e/o Service_name.
Nelle versioni precedenti, era supportata solo la connessione con SID.

Nuove stringhe variabili e-mail
Sono disponibili nuove variabili stringa di e-mail inviate e ricevute per le actions Loop, Import
DataSet e Export Dataset per inserire i valori inviati per data e ora.

Miglioramenti del supporto per Microsoft Exchange Web Services
La funzione Invia nel package Email supporta EWS OAuth2.0, migliorando in tal modo la
compatibilità con le versioni precedenti.

Migrazione manuale da Enterprise 11 a un ambiente abilitato al cloud
È ora possibile eseguire la migrazione manuale da Enterprise 11 a un ambiente abilitato al cloud. In
questa migrazione, è necessario creare manualmente tutte le entità quali utenti, ruoli e credenziali,
tranne i bots. Tutte le versioni Enterprise 11 sono supportate per questa migrazione.
Preparazione per abilitare la migrazione da Enterprise 11 a Automation 360 alla pagina 1201

Funzionalità esclusive di Enterprise 10

Migrazione di schermata MetaBots con la variabile tipo Password
È ora possibile eseguire la migrazione di bots Enterprise 10 basati su schermata MetaBot che
utilizzano la variabile tipo Password. Durante la migrazione, la logica (file .logic) nel file .mbot
viene migrata come nuovo TaskBot all'interno della cartella MetaBot . Inoltre, la variabile tipo
Password viene migrata come variabile di credenziali ed è assegnata a un locker predefinito .

Migrazione di TaskBots basati su schermata MetaBot e risorse DLL senza utilizzare la
logica
È ora possibile migrare un TaskBot che fa direttamente riferimento all'azione Esegui MetaBot per le
risorse Schermata e DLL MetaBot, senza utilizzare la logica MetaBot . In questo modo è possibile
migrare un TaskBot che contiene le risorse Schermata e DLL MetaBot.
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RPA Workspace

Novità

Miglioramenti alla navigazione di Automation 360
Abbiamo migliorato la leggibilità e l'accessibilità complessive dell'interfaccia Automation 360 .
Per semplificare la navigazione, i menu e le visualizzazioni sono organizzati in base alle funzioni
utilizzate di frequente e alle attività correlate.
L'interfaccia include i seguenti aggiornamenti:
• Le icone Dispositivo, Profilo e Guida si trovano ora nella parte inferiore del menu di navigazione

e tutti i comandi sono concentrati sulla sinistra per un facile accesso.
Facendo clic su queste icone, vengono visualizzati riquadri a comparsa di contenuti e azioni.

• Il menu di navigazione laterale può essere compresso in una barra sottile per ingrandire l'area di
lavoro principale.
È possibile continuare a utilizzare la barra di navigazione laterale in modalità compressa, con i
riquadri a comparsa per ciascuna sezione.

Automation 360 navigation updates

Autenticazione della connessione al database con credenziali Microsoft Azure Active
Directory (ID caso Service Cloud 00676448)
È ora possibile autenticare la connessione al database Control Room utilizzando le credenziali
Microsoft Azure Active Directory quando si installa Control Room su Microsoft Azure.
Configure Microsoft database type and server alla pagina 911

Miglioramenti dell'archivio chiave esterno
Il supporto di un archivio chiave esterno per AWS Secrets Manager e CyberArk per le credenziali di
accesso automatico e automazione è stato aggiunto a Automation 360. Le credenziali di accesso
automatico e di automazione (credenziali utilizzate dai bot) ora si possono recuperare dall'archivio
chiave esterno configurato.
Integrate external key vaults alla pagina 907

Distribuzione dell'automazione dei carichi di lavoro su un server di terminale Windows
multiutente
Per ottimizzare l'automazione dei carichi di lavoro e i dispositivi multiutente, è possibile distribuire
automazioni dei carichi di lavoro su un server di terminale Windows multiutente, in modo che un
singolo dispositivo possa elaborare più elementi contemporaneamente.
About multi-user devices alla pagina 2631 | About device pools alla pagina 2635

Controlli di compatibilità Control Room e Bot Agent per l'automazione
Per gestire il ciclo di vita dell'automazione, è possibile visualizzare le informazioni sulle dipendenze
relative alla compatibilità minima delle versioni di Control Room e Bot Agent quando si creano
e distribuiscono automazioni. È quindi possibile aggiornare l'automazione e ridurre gli errori di
runtime causati da una versione o incompatibile di Control Room o Bot Agent.
Actions palette for bot creation alla pagina 1363
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Novità

Nuove actions del package BAPI SAP
Utilizza le nuove actions seguenti:
• Esegui il flusso di lavoro standard: Esegue un flusso di lavoro standard in BAPI SAP.
• Esegui flusso di lavoro personalizzato: Esegue un flusso di lavoro personalizzato in BAPI

SAP.

BAPI SAP package alla pagina 1831

Nuova actions nel package File
Utilizza le nuove actions seguenti:
• Ottieni nome: Legge il nome di un file e lo memorizza in una stringa.
• Ottieni percorso: Recupera il percorso del file e lo memorizza in una stringa.

File package alla pagina 1562

Espressione tabella comune supportata nel package Database
È ora possibile utilizzare l'espressione tabella comune (CTE) nell'action Leggi da utilizzando la
parola chiave WITH (CON) nei database compatibili SQL come Oracle e MySQL. Utilizza le istruzioni
CTE all'interno di una query SQL per semplificare unioni e sottoquery complesse.
Using the Read from action alla pagina 1457

Supporto per numeri grandi nel Number package (ID caso Service Cloud: 00557619)
È ora possibile eseguire operazioni matematiche su numeri grandi con maggiore precisione nel
package Number.
Number package alla pagina 1695

Supporto per database Snowflake tramite driver OBDC (ID caso Service Cloud: 00761695)
Il driver OBDC Snowflake è ora supportato nel package Database. Puoi connetterti al database
Snowflake utilizzando le applicazioni client basate su ODBC.
I seguenti actions supportano questa funzionalità:
• Connetti
• Disconnetti
• Leggi da
• Esporta in tabella dati
• Inserisci/aggiorna/elimina

Variabili: nuove funzioni e miglioramenti (ID caso Service Cloud: 00740585)
• Modifica il nome della variabile dopo la creazione della variabile.
• Elimina tutte o una selezione specifica di variabili inutilizzate da un bot.

Universal Recorder new features and enhancements
• Registra le interazioni degli oggetti in applicazioni basate sul framework Electron.
• Doppio clic in tutte le applicazioni e i browser supportati.
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Novità

Limitazione dell'uso dell'attributo credenziale ai soli campi password (ID caso Service
Cloud: 00740585)
Quando si crea o si modifica un attributo credenziale, assicurati che i bots immettano il valore
dell'attributo solo nei campi identificati come campi password selezionando l'opzione Imposta
questo attributo come password.

Organizzare pool di dispositivi per controllare i dispositivi disponibili nell'ordine
preferito
Se si selezionano più pool di dispositivi (nella finestra Esegui ora o Programma), è ora possibile
organizzare i pool di dispositivi nell'ordine di preferenza. Quando un bot viene distribuito, la Control
Room seleziona il primo dispositivo disponibile in base all'ordine in cui sono stati organizzati i pool
di dispositivi. Se nessuno dei dispositivi è disponibile al momento della distribuzione, il bot viene
messo in coda.

Nomi predefiniti per le variabili di output
Quando si configura una variabile di output per le actions nei packages Error handler e Python
Script, la Control Room genera automaticamente un nome descrittivo predefinito della variabile. Se
si crea più di una variabile di output per un'action, ai nomi delle variabili successive viene aggiunto
-1, -2, -3 e così via per evitare un conflitto tra i nomi variabile.

Nuova action stringa per supportare le variabili nidificate
Utilizza l'action Stringa > Calcola valore per confrontare una variabile stringa specificata
dall'utente con le variabili stringa nel bot. Se viene trovata una corrispondenza, l'action restituisce il
valore della variabile corrispondente.
String package alla pagina 1881

Eliminazione di valori globali
A user with the AAE_Admin role can delete a global value from the All global values page.
Valori globali alla pagina 2044

Supporto della disponibilità elevata
Per gli utenti abilitati al cloud, la disponibilità elevata è supportata tramite distribuzioni a tre nodi.

Miglioramento del String package
Una nuova opzione per supportare gli stili di numerazione locali è ora disponibile nel package
String. È ora possibile selezionare il formato locale, rappresentato da ISO-3166.

File dipendenti e informazioni sui pacchetti in Esporta dettagli di audit del pacchetto
Nei dettagli di audit di un pacchetto esportato, è ora possibile visualizzare l'elenco dei file dipendenti
e dei pacchetti associati al pacchetto esportato. Questa funzione consente di analizzare il contenuto
del pacchetto esportato e identificare eventuali discrepanze. Se si sceglie di includere i pacchetti
durante un'esportazione, nei dettagli dell'audit saranno incluse solo le informazioni sul pacchetto.

Supporto del driver ODBC per tutte le stringhe di connessione (ID caso Service Cloud:
00748887, 00777676)
È ora disponibile un driver ODBC (Open Database Connectivity) per il supporto di tutte le stringhe
di connessione ODBC nello stesso modo in cui è stato utilizzato nella versione Enterprise 11.
Utilizzando SQL come standard per l'accesso e la gestione dei dati, è possibile connettersi a MySQL,
Google BigQuery, Snowflake e ad altri database utilizzando il driver ODBC.
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Novità

Condivisione di una sessione DLL
È ora possibile condividere una sessione DLL tra bots.

Nuova annotazione CredentialAllowPassword
Utilizza la nuova annotazione CredentialAllowPassword nel pacchetto SDK per consentire la
selezione di un attributo di credenziale contrassegnato come password. È possibile utilizzare questa
annotazione quando si crea un nuovo pacchetto SDK o quando se ne modifica uno esistente.
Configurare e utilizzare le credenziali per consentire l'annotazione della password alla pagina 2416

Miglioramenti alle autorizzazioni di archiviazione, estrazione e clonazione (ID caso di
Service Cloud: 00645904, 00720237, 00752197, 00760306, 00764684)
• Quando si esegue un'archiviazione, è ora possibile scegliere le dipendenze da sottoporre a

check-in insieme al bot. Le dipendenze con riferimento diretto verranno automaticamente
sottoposte ad archiviazione con il bot.

• Quando il bot viene sottoposto ad archiviazione insieme a una bot clonato e il clone non
contiene altri bots dipendenti, il bot viene ora eliminato.

• Quando si esegue un'estrazione, è ora possibile scegliere le dipendenze sulle quali si desidera
eseguire l'estrazione con il bot. Le dipendenze non selezionate durante l'estrazione vengono ora
clonate.

• Durante l'estrazione, è ora possibile sovrascrivere o sostituire un bot clonato.

Il programma di installazione di Bot Agent include il collegamento per AARI Assistant
Quando si installa un Bot Agent, sul desktop e nel menu di Windows viene aggiunto un
collegamento per accedere facilmente a AARI Assistant.
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039

Cosa è cambiato

Bot Scanner mostra bots non validi nell'elenco "impossibile migrare"
Bot Scanner è stato aggiornato e mostra i bots non validi come bloccati dalla migrazione, poiché
questi bots non validi producono errori prima e dopo la migrazione. Ad esempio l'esecuzione di bots
Enterprise 11 o Enterprise 10 che fanno riferimento a variabili inesistenti non riusciva. Pertanto,
alcuni bots non verranno più visualizzati nell'elenco di bots che possono essere migrati, ma
nell'elenco di quelli che non possono essere migrati del report visualizzato. Ciò può ridurre il
numero di bots che possono essere migrati a Automation 360.

Modifica dei nomi delle posizioni dei file e delle cartelle
Le posizioni dei file e i nomi delle cartelle sono ora aggiornati con la modifica del nome del prodotto
(da Enterprise A2019 a Automation 360). Ad esempio, la posizione del file per il percorso di
installazione predefinito viene modificata da C:\Program Files\Automation Anywhere
\Enterprise\ a C:\Program Files\Automation Anywhere\Automation360. A breve
aggiorneremo queste posizioni e i nomi nelle pagine della documentazione.
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Cosa è cambiato

La stringa di origine è opzionale nell'azione Dividi (ID caso Service Cloud: 000687257,
00702258)
Nei bots (inclusi i bots migrati da Enterprise 11), quando si utilizza l'action Dividi nel package
String, il campo Stringa sorgente è ora facoltativo. È possibile eseguire il bot senza fornire un
valore della stringa sorgente. I bots migrati che contengono stringhe di input vuote vengono ora
eseguiti correttamente.

Convalida dei prerequisiti obbligatoria prima della migrazione di bot
Quando si esegue la migrazione di bots utilizzando l'opzione Esegui la migrazione dei bot in
Bot Migration Wizard, viene visualizzato un messaggio di convalida dei prerequisiti con una lista
di controllo di tutti gli elementi di convalida. Il sistema ora convalida automaticamente questi
prerequisiti per garantire che tutti i prerequisiti siano soddisfatti prima di avviare la migrazione dei
bot. In precedenza, la convalida dei prerequisiti era facoltativa.
Se le convalide dei prerequisiti vengono completate con un errore, viene visualizzato un report
di convalida con l'elenco degli elementi per i quali la convalida non è riuscita. Se le convalide dei
prerequisiti vengono completate senza errori, viene avviata la migrazione dei bot.

Modifica del nome del database Control Room predefinito
Il nome predefinito del database Control Room è ora modificato da AAE-Database a Automation360-
Database.
Se si sta effettuando l'aggiornamento da una versione precedente a questa versione, immetti il
nome del database Control Room esistente per conservare i dati.

Clustering di Microsoft SQL Server per la disponibilità elevata
Ora puoi utilizzare il clustering di Microsoft SQL Server per un failover automatico e regolare delle
distribuzioni a disponibilità elevata nei cluster Control Room.
Database requirements alla pagina 845

Il nickname del Bot Agent è nascosto
Il nickname di un Bot Agent (aggiunto durante l'installazione) è ora nascosto quando la
registrazione di un dispositivo utente passa da un'istanza Control Room ad un'altra.

Modifica dell'interfaccia utente nell'action Apri di Excel packages
Nei packages Excel basic e Excel advanced, la casella di controllo Il foglio contiene
un'intestazione viene visualizzata ora sotto il campo Seleziona un file.

Modifica dell'interfaccia utente nella tavolozza Variabili
• L'elenco delle variabili Definita dall'utente è ora denominato Le tue variabili
• Le variabili Sistema, Stringa e Appunti sono organizzate all'interno di Variabili predefinite

Cifre con virgola considerate un numero valido (ID caso Service Cloud: 00623458)
Nei bots migrati, un gruppo di cifre che utilizza una virgola è ora considerato un numero valido.
Questa modifica consente di verificare correttamente le operazioni matematiche e le condizioni
variabili Se, Altrimenti se e Ciclo contenenti vari operatori.
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Cosa è cambiato

Il confronto delle date funziona con date in formati diversi (ID caso Service Cloud:
00723479)
Le azioni con condizioni di data vengono ora migrate con successo a condizioni di data equivalenti
in On-Premises. La condizione di data funziona ora con più sottoformati del formato principale
(mm/gg/aaaa). Pertanto, non è necessario modificare manualmente il formato della data in base al
formato di origine della migrazione bots che contiene stringhe data.

Utilizzo del valore stringa con operatori numerici
I bots migrati che contengono actions If o Mentre che utilizzano valori stringa o una variabile
contenente un valore stringa con operatori numerici <, <=, > e >= vengono ora eseguiti
correttamente.

Miglioramento dell'action Estrai campo nel package PDF
Utilizza l'action Visualizzatore PDF in Estrai campo per estrarre tutti i dati del campo e il testo
selezionato dal modulo e memorizzare i dati del modulo in variabili.
Using the Extract field action alla pagina 1734

Connessione automatica a SQL Server per l'autenticazione Windows (ID caso Service
Cloud: 00691554)
Quando si aggiorna Bot Agent, non è più necessario aggiungere manualmente i file dll per
connettersi al Microsoft SQL Server utilizzando l'autenticazione di Windows.
In precedenza, gli utenti dovevano aggiungere manualmente i file dll per configurare i dispositivi
e utilizzare l'action Connetti dal package Database per connettersi a Microsoft SQL Server con
l'autenticazione Windows NT.

Miglioramento della mappatura Active Directory
È ora possibile creare gruppi AD utilizzando le virgole nel nome lato server e lato Control Room. In
precedenza, ciò causava un errore.

Miglioramento della action Dividi del package String
La migrazione di bots ora viene eseguita correttamente quando si utilizza una action Dividi per
suddividere una stringa disponibile in una variabile di input quando tale variabile è vuota.

La tabella seguente elenca le correzioni e le build in cui sono state corrette. Build 9664 è la build più
recente per Cloud e include correzioni delle build precedenti. On-Premises è nella Build 9664.
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Correzioni

Crea ID caso Service Cloud Descrizione

9664 00803314 Nella versione più recente dell'utilità di
migrazione di Cloud sono stati risolti i
seguenti problemi:
• L'utilità controlla la versione corrente della

Control Room Enterprise 11 e procede
solo se tale versione è supportata per la
migrazione a Automation 360.

• Quando si accede alla schermata del
codice di migrazione, l'utilità visualizza le
informazioni del tenant di destinazione
nella schermata di convalida.

• Non si verifica più un errore quando
viene consentito l'accesso a: https://
aws.amazon.com e https://aa-
provsvc.globalservices.automationanywhere.digital/

• L'utilità carica tutti i dati richiesti in
Automation 360 Cloud.

9664 00790884, 00781022 La durata della registrazione di un processo
ora viene visualizzata correttamente in Ciclo
del processo sulla scheda del processo.
In precedenza la durata della registrazione
non veniva visualizzata a causa di un ritardo
nella connettività di rete. Ora è possibile
visualizzare tutte le fasi registrate acquisite
dal registratore dalla pagina Registrazioni.

9664 00785310 Non si verificano più problemi quando si
utilizza Universal Recorder per registrare le
actions da tastiera su un'applicazione. Ora il
Universal Recorder acquisisce correttamente il
valore delle sequenze di tasti. In precedenza,
il Universal Recorder acquisiva solo il primo
valore del tasto premuto.

9664 00767315, 00777786,
00775209, 00787736,
00797261, 00795511,
00796245, 007956217,
00798533, 00795084

Non si verificano più problemi a causa della
scadenza della cache globale e dei file
parzialmente eliminati nella cartella delle
risorse incorporate (C:\ProgramData
\AutomationAnywhere\GlobalCache
\embedded-resources) quando si installa
un Bot Agent per questa versione e si
acquisiscono oggetti in Google Chrome
utilizzando il pacchetto Recorder.
Se la cartella delle risorse incorporate del
dispositivo del Bot Agent è parzialmente
eliminata, sarà necessario prima eliminare la
cache globale e aggiornare il Bot Agent.
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9664 00796598 Quando si eseguono i bots del carico di
lavoro con la coda sui dispositivi di Bot
Runner, i bots non si bloccano in modo
intermittente dopo l'aggiornamento di
Automation 360 Cloud dalla versione
precedente a questa versione.

9642 -- Le istanze della Control Room configurate
con Active Directory per l'autenticazione con
il recupero delle credenziali da un archivio
chiave esterno non avevano esito positivo
a causa dell'anteposizione errata dei nomi
di dominio nei nomi di oggetto (CyberArk)
e nomi segreti (AWS) che causava errori
nell'autenticazione. Il problema è stato risolto
e i nomi di oggetto (CyberArk) e segreti
(AWS) ora sono formattati correttamente.

9637 00784333, 00784890,
00784382, 00784338,
00780635, 00791587,
00795559, 00795632,
00797130, 00797113, 00791783

Le distribuzioni di Bot non vengono più
bloccate in una coda dopo l'aggiornamento
di Automation 360 Cloud da una versione
precedente a questa versione.

9637 00780756 Ora è possibile eseguire il check-in dei bots
con una dipendenza condivisa con altri bots.
In precedenza, il check-in non riusciva a
causa di un problema con i bots clonati che
perdevano le dipendenze durante il check-in,
indipendentemente dai bots padre esistenti.

9595 00733638, 00756399 Bots che utilizzano una variabile per
specificare il bot figlio da eseguire non
riscontrano più un errore perché il percorso
variabilizzato contiene una barra rovesciata.

9595 00711390 Il meccanismo di ripetizione consente ora di
eseguire la migrazione di file .atmx di grandi
dimensioni. In precedenza, quando veniva
migrato un file .atmx di grandi dimensioni,
la connessione con Control Room diventava
obsoleta o non autenticata, causando un
errore NoHttpResponseException.
Con il meccanismo di ripetizione, l'utilità di
migrazione tenta di creare una connessione
con la Control Room per 5 volte finché
la connessione non viene ripristinata
correttamente.

9595 00730369, 00747866 Le actions Registratore funzionano ora
correttamente, consentendo l'esecuzione del
bot senza alcun ritardo. In precedenza, era
necessario un tempo maggiore per eseguire il
bot a causa di un lungo ritardo.
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9595 00733383, 00754559 La variabile contatore Loop funziona ora
correttamente per la migrazione dei bots. La
variabile viene ora migrata come parte dei
comandi XML e Tabella dati.

9595 -- Quando si aggiornano le query SQL in un
bot migrato utilizzando le azioni Leggi da e
Inserisci/Aggiorna/Elimina del pacchetto
Database, il formato esistente della query
non viene più modificato automaticamente.
In precedenza, quando si modificavano le
query SQL in un bot migrato, i caratteri
venivano inseriti in modo errato.

9595 00721238 È ora possibile utilizzare l'azione Browser
per accedere a un URL con parametri
utilizzando il browser Microsoft Edge. In
precedenza, quando si effettuava l'accesso
a un URL con parametri tramite l'azione
Browser utilizzando Microsoft Edge, i
parametri URL venivano troncati dal carattere
& (e) dopo l'esecuzione del bot.

9595 00721488 bots Enterprise 11 che utilizzano il comando
Ottieni più nodi, non dà più un output
diverso dopo la migrazione. In precedenza,
il bot migrato restituiva l'output in base alla
struttura del file XML, mentre il bot Enterprise
11 forniva un output su un'unica riga.

9595 -- Non si verifica più un problema quando si
eseguono bots migrati da Enterprise 11
che utilizzano nomi identici per le variabili
differenziate da un trattino o da un trattino
basso (ad esempio L-Inferiore e L_Inferiore).
Il nome della variabile che contiene un
trattino viene ora aggiunto con alcune parole
chiave (ad esempio la variabile Arr-val viene
aggiornata ad Arr-val-MIG-SPL-25). In
precedenza, dopo la migrazione l'esecuzione
dei bots non andava a buon fine.

9595 00729931 Dopo la migrazione, quando viene generato
il file bot, viene ora migrato il DOMXPath
corretto. In precedenza, veniva migrato un
DOMXPath errato.

9595 00738643 Le condizioni Se e Ciclo, se utilizzate in una
combinazione di condizioni multiple E o O ora
funzionano correttamente. In precedenza,
l'utilizzo delle condizioni Se e Ciclo con più
condizioni causava un errore logico nel bot.
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9595 00743808, 00754554 bots migrati che utilizzano il comando If con
una variabile nel formato HH:MM funzionano
correttamente e non riscontrano più alcun
problema.

9595 00678059 È ora possibile scaricare i pacchetti esportati
se il nome bot contiene caratteri giapponesi
e un carattere di sottolineatura (_). In
precedenza, se il nome conteneva tali
caratteri, si verificava un errore imprevisto
che impediva all'utente di scaricare il
pacchetto.

9595 -- Quando si esegue un bot migrato contenente
l'action, Excel avanzato > Trova, la cella
trovata è ora attiva e le actions successive
possono eseguire operazioni su di essa.

9595 00731512 Non è più possibile modificare un bot e
modificare il percorso del file di archivio del
bot dalla cartella pubblica a quella privata
aggiornando l'URL Control Room e il percorso
dell'archivio nel browser.

9595 00734059 I messaggi relativi al tipo di INFORMAZIONI
non vengono più duplicati nel file Control
Room WebCR.log.

9595 -- Quando si installa un Bot Agent a livello
utente, il dispositivo utente viene ora
registrato come amministratore.

9595 00744663, 00747831,
00737488, 00752613

È ora possibile esportare correttamente un
bot che contiene il package Recorder.

9595 00726433 Risolto un problema con le API Microsoft
Graph che causava errori quando un bot
scaricava file da OneDrive. I Bots possono ora
eseguire correttamente l'action Office 365
OneDrive > Scarica file.

9595 00703553 Quando viene creato un nuovo utente, l'API
di controllo restituisce ora i valori corretti per
i parametri Descrizione evento e Nome
utente.

9595 00729563 L'estensione del file atmx non distingue più
tra maiuscole e minuscole. È ora possibile
eseguire la migrazione di attività che
includono lettere maiuscole o minuscole
nelle loro estensioni di file. In precedenza,
le attività con lettere maiuscole nelle loro
estensioni di file non venivano migrate da Bot
Migration Wizard.
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9595 00740548 Lo stato del Bot viene ora visualizzato
correttamente dopo l'esecuzione di un
processo. In precedenza, i bots programmati
venivano occasionalmente erroneamente
etichettati come attività in corso,
anche se il bot aveva completato il processo.

9595 00731508 È ora possibile inserire caratteri nordici
nell'attributo credenziale e nei valori delle
variabili delle credenziali.

9595 00695176, 00692676 bots appena copiati contenenti un trigger
di evento vengono ora eseguiti quando si
verifica l'evento di attivazione.

9595 00759742 Quando si inserisce una variabile in una
stringa di testo, la variabile viene ora inserita
nella posizione del cursore. In precedenza, la
variabile veniva inserita alla fine della stringa
e non nella posizione del cursore.

9595 -- Ora puoi effettuare con successo la
distribuzione di bots dal Bot editor. In
precedenza, quando l'utente Bot Creator
o Bot Runner (assistito o non assistito)
effettuava l'accesso alla Control Room e
se l'opzione di download del package era
attivata, il download del package aveva la
priorità e la distribuzione del bot doveva
attendere il completamento del download del
package.

9595 00730211 Quando si utilizza il package Recorder >
Ottieni proprietà action per estrarre
la proprietà percorso dell'oggetto, il
registratore recupera ora il valore degli
attributi altezza e percorso dell'oggetto
acquisito. In precedenza, gli attributi altezza e
percorso dell'oggetto registrato non venivano
recuperati dal bot.

9595 00716793 Non si verifica più un problema quando si
esegue un bot utilizzando il package SOAP
Web Service con parametri di input non
formattati. In precedenza, l'esecuzione
bot non andava a buon fine e si verificava
un errore poiché i parametri di input non
formattati non erano formattati in formato
XML dal bot.
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9595 00706709 Nel package Email, quando si utilizza la
connessione Outlook per recuperare le e-mail
con il filtro data, tutte le e-mail vengono ora
recuperate correttamente. In precedenza,
tutte le e-mail non venivano recuperate
dall'applicazione quando veniva applicato il
filtro data.

9595 00714292 Per supportare le doppie barre rovesciate
(\\) nella posizione del file per actions
che utilizzano l'input da file, è necessario
impostare Versione di compatibilità
bot come 2 nella pagina Impostazioni
avanzate del Bot editor. In precedenza,
l'esecuzione del bot non andava a buon fine
perché la doppia barra rovesciata (\\) nel
percorso del file veniva sostituita da una
barra quando si selezionava un percorso di
rete utilizzando l'opzione Sfoglia.

9595 00697460 Quando si seleziona il registratore nella
condizione If, il registratore individua ora
l'oggetto nell'applicazione Oracle EBS e
acquisisce le proprietà corrette dell'oggetto
senza errori. In precedenza, il registratore
non riusciva a trovare l'oggetto quando
questo veniva acquisito con condizione If.

9595 -- In Microsoft Edge o Firefox, quando un
bot apre un sito Web all'interno di un ciclo,
l'action Recorder Acquisisci funziona
ora correttamente dopo l'esecuzione
dell'operazione di lancio del sito Web. In
precedenza, l'action non andava a buon fine
dopo l'esecuzione del lancio del sito Web.

9595 00710257 Nel package Recorder, l'action Acquisisci
funziona ora senza problemi. In precedenza,
il Recorder non funzionava dando un errore di
timeout perché i dettagli del proxy di rete non
venivano recuperati.

9595 00735480 Il TaskBot funziona ora meglio quando si
utilizza l'action Ciclo per eseguire un bot. In
precedenza, TaskBot impiegava molto tempo
per completare l'esecuzione.

9595 00559868 Quando si usa il package Datetime > action
Assegna per convertire una variabile Data
e ora utilizzando il formato personalizzato
gg-mm-aaaa, il bot viene ora eseguito senza
errori. In precedenza, l'esecuzione del bot
non andava a buon fine causa la presenza
di caratteri con distinzione tra maiuscole e
minuscole nel formato Data e ora.
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9595 -- È ora supportata la migrazione delle stringhe
di connessione del database PaaS (Azure
SQL) tramite un driver ODBC.

9595 00733651 È ora possibile visualizzare il tempo medio
impiegato per creare una metrica TaskBot in
Control Room su diverse pagine facendo clic
su un numero di pagina.

9595 00742305 Quando si disattiva un nodo su un cluster a
tre nodi e si accede alla Control Room, non
viene più visualizzato il seguente errore: Il
gruppo di cluster è vuoto.

9595 00712190, 00698197, 00700574 Quando si distribuisce un bot con valori di
stringa che superano il limite consentito
di 2 - 4 MB, la Control Room riconosce
il valore come un'eccezione e visualizza
ora il seguente messaggio di errore: 400
Richiesta non valida.

9595 00754585, 00755448 Quando si esegue un bot, le dipendenze che
includono bots figlio vengono ora scaricate. Il
bot non mostra più lo stato sconosciuto e la
sessione come scaduta.

9595 -- Quando si esegue la migrazione del Database
comando, non è ora necessaria alcuna
configurazione aggiuntiva.

9595 00745046 Ora puoi effettuare l'archiviazione dei bots
senza problemi. In precedenza, l'archiviazione
dei bot non andava a buon fine perché
l'archivio Git risultava danneggiato in modo
intermittente.

9595 00677638 Quando si aggiunge un dispositivo utente
come dispositivo predefinito alla Control
Room, la pagina Dispositivi lo visualizza
ora automaticamente come dispositivo
predefinito. Non è più necessario accedere
nuovamente alla Control Room o aggiornare
la pagina Control Room.

9595 00733370 Gli utenti che hanno effettuato l'accesso
a dispositivi condivisi temporanei (non
persistenti) possono ora accedere alla Control
Room dopo che una sessione precedente
sul dispositivo temporaneo è stata eliminata
dall'amministratore della Control Room.
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9595 00736950 I MetaBots che utilizzano caratteri giapponesi
(stringa a doppio byte) come variabile di
output, possono ora essere salvati ed eseguiti
correttamente dopo che i MetaBots sono
stati migrati a On-Premises utilizzando la
procedura guidata di migrazione.

9595 00723924 L'emulatore di terminale tipo ANSI accetta ora
una password contenente parentesi o {}. In
precedenza, quando nella password venivano
utilizzate le parentesi, nella schermata del
terminale veniva visualizzato un messaggio di
errore relativo a nome utente e password non
validi.

Limitazioni

(ID caso Service Cloud: 00797199) If multiple instances of Bot Agent in Google Chrome browser
are displayed and multiple Google profiles (accounts) are open in the browsers, you might not be
able to use the Recorder > Capture command. You might see an error message that informs you
that the Google Chrome plug-in not installed.
Soluzione: Automation 360 supports only a single profile for automation. Therefore, we
recommend that you either configure a single Google profile in Google Chrome or, if you are using
multiple profiles simultaneously in Google Chrome and want to automate one profile, enable the
Automation 360 extension for Chrome on only one of the Google profiles.

(ID caso Service Cloud: 01071731) When you open a CSV or TXT file, read data from that file, and
write the data from a Table type variable to the file, the bot fails with an error if the CSV or TXT file
contains large data sets. Also, Create folders/files if it doesn't exist and Override existing
file check boxes are selected in the Write to file action.
Soluzione: Perform one of the following:
• In the task, when you use the Open action for a CSV or TXT file, select the Contains header

check box to prevent your bot from failing.
• Use the Excel advanced Open action to open a CSV file and then use the Write from data

table action to write data into the file.

(ID caso Service Cloud: 00793818) se si modifica contemporaneamente un numero elevato di
pianificazioni (ad esempio, più di 40) in Control Room dalla pagina Attività programmata, le
pianificazioni non verranno attivate.
Consiglio: Utilizzare l'opzione di modifica per ogni singola pianificazione per evitare sovraccarichi.
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(ID caso Service Cloud: 00805571) Quando Bot Agent viene aggiornato automaticamente per le
distribuzioni di Cloud, lo stato di Bot Agent cambia rapidamente tra Connesso e Aggiornamento
nella pagina Dispositivi. I registri di Bot Agent indicano che il processo di aggiornamento
automatico è stato avviato, ma il dispositivo non si connette al server WebSocket.
Soluzione: Eliminare il file di database locale AA-DB.mv.db da C:\Windows
\System32\config\systemprofile\AppData\Local\AutomationAnywhere e riavviare il
servizio Bot Agent. Se l'aggiornamento automatico è attivato nelle impostazioni della Control Room,
Bot Agent viene aggiornato automaticamente. Se l'impostazione è disattivata, sarà necessario
aggiornare Bot Agent manualmente.

Se un dispositivo o un servizio di Bot Agent viene riavviato durante l'esecuzione di bots, i bots
vengono visualizzati come Attivo nella pagina Attività anziché come Non riuscito a causa delle
modifiche allo schema di risposta nel prodotto.
Soluzione: Eliminare il file AA-DB.mv.db da C:\Windows\System32\config
\systemprofile\AppData\Local\AutomationAnywhere e riavviare il servizio Bot
Agent. Le distribuzioni bloccate nello stato Attivo verranno spostate nella pagina Cronologia e
contrassegnate come Non riuscito, in modo che le distribuzioni successive possano procedere.

Si verificano problemi intermittenti con l'esecuzione di bots pianificati, con alcune pianificazioni
esistenti che si comportano in modo incoerente o alcune pianificazioni appena create che non
vengono più visualizzate. La nuova funzionalità per impostare la priorità su Alta è stata ripristinata
per risolvere questo problema. Per gli utenti che hanno utilizzato questa funzionalità nella build
9637 o precedenti e sono passati alla build 9664, le pianificazioni funzionano indipendentemente
dall'impostazione della priorità.
Soluzione: Se si verificano questi problemi, suddividere un'automazione pianificata di grandi
dimensioni in pianificazioni più piccole di 2 ore ciascuna da eseguire durante la giornata. Ad
esempio, riconfigurare un'automazione pianificata su un periodo di 12 ore, dalle 9:00 alle 21:00,
a intervalli di due ore, ad esempio dalle 9:00 alle 10:59, dalle 11:00 alle 12:59 e dalle 13:00 alle
14:59. È vivamente consigliato utilizzare intervalli di 2 ore per tali distribuzioni. Ulteriori consigli per
pianificazioni e intervalli di tempo: eventuali pianificazioni con una frequenza inferiore (< 10 minuti)
devono essere distanziate di almeno 10 minuti (ID caso Service Cloud: 00792385, 00785679,
00795915, 00793147, 00794555).

Comportamento noto delle porte configurate su più istanze
Quando si installa Control Room e si configura il database, le porte per più istanze devono
corrispondere alle porte TCP configurate nelle proprietà TCP/IP. Ad esempio, se per la prima istanza
la porta TCP configurata è 1434 e per la seconda istanza la porta TCP configurata è 1435, durante
l'installazione di Control Room si deve aggiungere 1434 come porta per la prima istanza e 1435
come porta per la seconda istanza.
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Il Universal Recorder ha le seguenti limitazioni durante l'acquisizione di oggetti nelle app Electron:
• L'action Seleziona in una casella di controllo non è attualmente supportata.

Soluzione: Utilizzare al suo posto Toggle, Clic oppure Clic sinistro.
• Il Universal Recorder non è in grado di acquisire dati tabulari.

Soluzione: Quando il Universal Recorder acquisisce un controllo oggetto di Client,
selezionare l'action OttieniTuttiNomiFiglio e memorizzare i dati in una variabile elenco.

• Il Universal Recorder potrebbe acquisire la finestra contenente Microsoft Teams come tecnologia
Client, anziché l'oggetto previsto.
Soluzione: Chiudere e riaprire Microsoft Teams.

• Universal Recorder supporta solo l'acquisizione di oggetti da app Electron in un computer con
scala di visualizzazione configurata al 100% o con un'impostazione di riconoscimento DPI.

Se si supera il numero massimo di connessioni ActiveMQ consentite, può verificarsi un errore AMQ
quando si esegue un'automazione RunTask per 5 volte, con ogni ciclo che esegue 20 o più bots
dopo il quarto ciclo.

Archivio chiave esterno
Le opzioni di configurazione Crea/Modifica utente includono ancora il campo che consente
all'amministratore di immettere le credenziali della periferica per l'utente. Quando l'accesso
automatico è configurato per l'archivio chiave esterno, questi campi sono ancora visualizzabili
e appaiono modificabili; tuttavia, le credenziali aggiunte non hanno effetto sul recupero delle
credenziali di accesso automatico dall'archivio esterno.

Si potrebbe notare un aumento dell'utilizzo della CPU di circa il 10% quando Control Room è in
stato di inattività (ID caso Service Cloud: 00801733).

Quando si aggiorna la Control Room su Linux da Automation 360 v.19 o v.20 a Automation 360
v.21, la Control Room continua a visualizzare l'interfaccia della versione precedente.
Soluzione: La schermata del browser deve essere aggiornata per caricare l'interfaccia utente nella
nuova versione.

Automation Anywhere Robotic Interface (AARI)

Novità

AARI Assistant for attended Bot Runners
L'applicazione AARI Assistant consente agli utenti con licenza Bot Runner assistiti l'accesso ai propri
bots senza accedere alla Control Room. Gli utenti Web di AARI possono utilizzare AARI Assistant
solo quando la licenza assistita di Bot Runner è attivata insieme alla licenza utente di AARI senza
influire sulle funzionalità esistenti.
Informazioni su AARI Assistant alla pagina 2180

Scaricare, eliminare o visualizzare i file nel browser in moduli o attività iniziali
Gli utenti possono ora utilizzare l'elemento Seleziona file per scaricare i file caricati in moduli o
attività iniziali e possono anche eliminare i file o accedere al file di collegamento ipertestuale per
visualizzare il file all'interno del browser. È possibile accedere al file caricato come collegamento
ipertestuale e scaricare ed eliminare nuove icone.
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Miglioramento dei ruoli all'interno del team
Il team AARI prevede tre ruoli:
• Membro: L'utente può creare, modificare ed eliminare le proprie richieste. In un team privato,

tutti i compiti vengono assegnati automaticamente al membro al momento della creazione della
richiesta. In un team condiviso, il membro può assegnare attività ad altri membri.

• Proprietario: Può creare, visualizzare, eliminare e assegnare tutte le richieste dei membri del
team.

• Amministratore: Può creare, visualizzare, eliminare e assegnare tutte le richieste dei membri del
team. L'amministratore può anche modificare il team.

Un amministratore o manager AARI può modificare i propri team e aggiornare i ruoli dei membri
del team. Inoltre, può aggiungere o rimuovere i membri del team. Per impostazione predefinita, il
manager AARI è l'amministratore del team quando crea un team.

Miglioramento della creazione di richieste
Una richiesta può ora essere creata da un utente o da un bot nella pagina Modifica processo.
• Scegli l'opzione per utente per visualizzare il processo nella pagina Processi.
• Scegli l'opzione per bot in modo che la richiesta venga creata da un bot o da un altro processo

utilizzando Attività processo.
Non è possibile visualizzare il processo o creare una richiesta con questa opzione. Poiché la
richiesta viene creata all'interno di un team, specifica il team predefinito nel campo Team
predefinito per ricevere la richiesta creata dal bot nella pagina Modifica processo.

Assegnare un team AARI a un processo alla pagina 2166

Funzione Assegna a me nelle attività
Quando l'assegnazione di un'attività viene annullata e gli utenti accedono alle attività, utilizzare
l'opzione Assegna a me per consentire l'assegnazione delle attività all'Assegna a me per
consentire l'assegnazione delle attività all'utente corrente in modo da consentire l'accesso
immediato al modulo.
Assign or unassign a task alla pagina 2167

Nuova pagina Bot
Quando i membri del team AARI con licenze Bot Runner assistiti accedono all'interfaccia Web,
vengono reindirizzati automaticamente a AARI Assistant. Gli utenti possono visualizzare tutti i bots
creati da loro in questa pagina. Possono inoltre aggiungere, cercare e ordinare i bots loro assegnati.

Nuovo riferimento al team nelle pagine Richiesta e Processo
L'utente può ora fare riferimento al team da cui viene creata una richiesta facendo riferimento alla
nuova colonna Team nella pagina Richiesta o al nome del team aggiunto al titolo del processo
nella pagina Processo, per guidare l'assegnazione del team.

Nuovo campo Visibilità richiesta (ID caso Service Cloud: 00718119)
Visibilità richiesta permette agli utenti di consentire o limitare l'accesso da parte di altri membri del
team a una richiesta creata. Quando il campo Visibilità richiesta è impostato su Condivisa, tutte
le richieste sono accessibili a tutti i membri, i proprietari e agli amministratori del team. Se il campo
è impostato su Privata, le richieste sono disponibili solo per l'utente che ha creato la richiesta, il
proprietario e l'amministratore del team.
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Novità

Miglioramenti alla pagina Processi
Nella pagina Processi sono disponibili i seguenti miglioramenti:
• Ordinamento dei processi per nome, in ordine crescente o decrescente.
• Attivazione/disattivazione del blocco di un processo.
• Utilizzo della visualizzazione dinamica per regolare la visualizzazione in base alle dimensioni dello

schermo.

Utilizzo dell'archiviazione nel cloud
In base alle dimensioni massime dei file e del dispositivo di archiviazione, gli utenti che caricano i
file possono utilizzare l'archiviazione nel cloud. Le dimensioni per l'archiviazione sono le seguenti:
• La dimensione del file caricato utilizzando l'elemento Seleziona file non può superare i 25 MB.
• Per impostazione predefinita, l'archivio può memorizzare un massimo di 100 MB di dati.
• L'archivio può accettare 1 GB aggiuntivo per ogni licenza utente AARI assegnata.

Funzionalità di copia del processo in URI
L'amministratore di AARI può utilizzare la nuova funzionalità Copia processo in uri negli Appunti
nella pagina Configurazione del processo per ottenere i dati URI e condividerli con i membri del
team, come riferimento quando si devono immettere i dati URI nell'azione Crea una richiesta.
AARI Web package alla pagina 1369

Aggiunta di righe dal menu contestuale della riga d'intestazione
Quando durante il runtime del bot viene avviato un modulo con una tabella, viene visualizzata solo
la riga dell'intestazione. Utilizza uno dei seguenti metodi per aggiungere nuove righe alla tabella:
• Menu contestuale riga d'intestazione della tabella

Utilizzo dell'elemento Tabella alla pagina 2200
• Azione Imposta in un bot

Imposta action alla pagina 1876

Supporto per i trigger interfaccia su Google Chrome
I trigger interfaccia sono ora supportati nel browser Google Chrome per le seguenti azioni durante il
runtime del bot:
• Quando si fa clic su un elemento pulsante in un modulo
• Per le azioni Attivato e Disattivato in una casella di testo
• Quando viene utilizzato un tasto di scelta rapida preconfigurato con l'azione Attivato in una

casella di testo

Add an interface trigger alla pagina 2213
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Cosa è cambiato

Modifiche dell'aggiornamento a team e processi
Per gli utenti che accedevano ai processi, quando effettuano l'aggiornamento alla versione più
recente di Automation 360, i team esistenti rimangono invariati ma ora sono impostati su un tipo
di team condiviso, indipendentemente dall'assegnazione del team esistente. Utenti e manager di
AARI vengono ora convertiti rispettivamente nei ruoli di membro e amministratore del team.
Mentre gli eventuali processi esistenti assegnati al team dopo l'aggiornamento vengono visualizzati
come Team migrato per il processo.
Per i manager (manager di processo) di AARI che potevano creare richieste senza assegnare il
processo ai team. Dopo l'aggiornamento, i manager di AARI devono creare i team e chiedere
all'amministratore di AARI di assegnare i team a un processo al fine di creare nuove richieste.
I processi hanno l'opzione per utente configurata per impostazione predefinita per consentire
ai team di visualizzare un processo. È necessario scegliere l'opzione per bot per ottenere che la
richiesta venga creata dai bots o da un altro processo.
Utilizzo di AARI sull'interfaccia Web alla pagina 2109 | Assegnare un team AARI a un processo alla
pagina 2166

Aggiornamento alla funzione Assegnazione automatica
• In Attività umana, non è più possibile utilizzare la funzione di assegnazione automatica per

assegnare automaticamente l'attività al manager. Puoi anche assegnare automaticamente
l'attività all'utente che ha creato la richiesta.

• L'opzione per assegnare l'attività di destinazione al manager è stata ora rimossa dall'elemento
Vai a.
È ora possibile ignorare l'impostazione di assegnazione automatica precedente selezionando
l'opzione Ignora impostazione assegnazione attività nel pannello Vai a annullando
l'assegnazione dell'attività o assegnandola all'utente che ha creato la richiesta.

La tabella seguente elenca le correzioni e le build in cui sono state corrette. Build 9664 è la build più
recente per Cloud e include correzioni delle build precedenti (compresa la Build 9604). On-Premises è nella
Build 9664.

Correzioni

Crea ID caso Service Cloud Descrizione

9664 00788255 Dopo l'aggiornamento da v.19 a questa versione,
i processi che contengono i moduli con l'elemento
Tabella, Casella di controllo o Casella di testo
ora vengono eseguiti correttamente. In precedenza, se
conteneva un modulo con una tabella, una casella di
controllo o una casella di testo vuota, il processo non
veniva eseguito correttamente quando non si erano
apportate modifiche al modulo.

9664 00772925 Il layout della pagina di visualizzazione della richiesta
non cambia più quando l'utente seleziona una lingua
diversa dall'inglese.

9664 00781891, 00784947 Il rendering del testo di avviso nell'editor dei processi
ora viene eseguito correttamente con la codifica
UTF-8.
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Correzioni

Crea ID caso Service Cloud Descrizione

9664 -- Gli utenti con licenza assistita vengono ora reindirizzati
correttamente all'applicazione AARI Assistant
quando accedono dallo stesso dispositivo utilizzato in
precedenza da un utente senza licenza assistita per
tentare di accedere all'applicazione.

9604 00765406 Quando si immettono più di quattro valori numerici con
una virgola in un campo elemento Numero nei moduli
iniziali o nelle attività, il campo può ora accettare il
valore numerico senza problemi.

9595 00719862 Nella pagina Configurazione del team è ora
possibile visualizzare i membri del team e verificare
se il numero di membri è coerente con il numero di
membri del team.

9595 00738934 Gli utenti possono ora visualizzare, caricare, scaricare
o eliminare i loro file quando aggiungono l'elemento
Seleziona file ai moduli per completare le attività
nell'interfaccia Web.

9595 00767008 Caricando un file con l'elemento Seleziona file nelle
tue attività, il bot scarica ora il file tramite l'azione
Ottieni file di archiviazione senza problemi.

9595 -- Il testo lungo per il nome dell'etichetta degli elementi
Pulsante di opzione e Casella di controllo in un
modulo è ora completamente visualizzato.

Limitazioni

(ID caso Service Cloud: 00831376) When you use the storage service to upload or download files
from the web interface, the download is redirected to an AWS and GCP presigned URL. You will not
be able to download files unless you whitelist the AWS and GCP URLS.
Soluzione: You must whitelist the following URL in order to download:
• AWS: https://<bucket-name>.s3.<region>.amazonaws.com/
• GCP: https://storage.googleapis.com/<bucket-name>/

(ID caso Service Cloud: 00789181) Quando un bot viene distribuito in AARI e la distribuzione
non viene completata anche dopo un'ora, l'esecuzione del bot non riesce e lo stato diventa Non
riuscito in AARI. Tuttavia, lo stesso bot viene ancora eseguito nella Control Room.
Soluzione:
Scegliere una o entrambe le seguenti opzioni:
• Definire una durata adeguata per l'esecuzione del bot.
• Aumentare le dimensioni del pool di dispositivi.
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Limitazioni

Per On-Premises, quando si accede all'applicazione AARI Assistant come utente non assistito, viene
visualizzato un errore come previsto. Tuttavia, se si utilizzano le stesse credenziali o le credenziali
di un altro utente non assistito e si accede nuovamente all'applicazione, viene visualizzata la pagina
dell'interfaccia Web.
Soluzione:
1. Accedere a AARI Assistant come utente assistito.
2. First, log in to the web interface (aari/#/assistant URL) then log out without changing

anything in the browser. Quindi, passare all'applicazione AARI Assistant sul desktop e accedere
come utente assistito.

La colonna Team nella pagina Configurazione del processo non viene aggiornata
automaticamente quando l'amministratore AARI aggiunge o rimuove il proprio team in un processo.
Soluzioni: Utilizzare le seguenti opzioni nella pagina Configurazione del processo:
• Fare clic sull'opzione Aggiorna l'elenco.
• Fare clic sull'opzione di aggiornamento del browser per ricaricare la pagina.
• Passare a un'altra scheda e tornare a questa pagina.

Quando si utilizza Attività del processo nell'editor di processo, non è possibile utilizzare l'opzione
Cartella pubblica nel campo Seleziona un file di processo, poiché l'aggiunta di un processo
pubblico come dipendenza dal processo privato non è supportata.

Quando gli utenti utilizzano l'elemento Immagine per eseguire il rendering delle immagini, non
viene eseguito il rendering delle immagini esterne nella visualizzazione della richiesta quando gli
utenti eseguono le proprie attività.

Discovery Bot

Novità

Ordinare un titolo processo dalla pagina Processi
È ora possibile utilizzare il campo Ordina per individuare rapidamente un titolo di processo. Dalla
pagina Processi utilizza il menu a discesa per ordinare in ordine alfabetico un titolo di processo in
base al nome del processo. In alternativa, è possibile ordinare dal processo più recente creato al
processo meno recente e viceversa.
Create a Discovery Bot process alla pagina 2344
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Novità

Miglioramenti delle opportunità
Ora puoi rivedere e analizzare immediatamente le opportunità generate automaticamente (o
generate dal sistema) dalla pagina Opportunità. Le opportunità generate automaticamente
vengono create quando almeno due registrazioni vengono approvate dall'utente. È possibile creare
un'opportunità personalizzata da un'opportunità generata automaticamente e applicare le opzioni
Modello e Filtro per individuare un'opportunità specifica per l'automazione.
È ora possibile assegnare in un processo priorità alle opportunità in base a una formula semplice
per tutte le registrazioni. Dalla tabella Opportunità, è possibile visualizzare il costo senza
automazione e risparmi per una particolare opportunità. Il sistema calcola automaticamente i costi
e i potenziali risparmi per ogni opportunità generata. Puoi personalizzare queste metriche in base al
modello della tua organizzazione per quanto riguarda costi e risparmi.
Review opportunities and convert to

I file PDD generati sono disponibili sul server locale
Il file PDD generato per un'opportunità viene ora memorizzato localmente sul server per
le distribuzioni On-Premises. I file PDD esistenti vengono automaticamente spostati nella
nuova posizione e non vengono eliminati quando viene eseguita una nuova installazione o un
aggiornamento in Control Room.
Prerequisiti per Discovery Bot alla pagina 2335

Correzioni

ID caso Service Cloud Descrizione

-- Fai doppio clic, trascina, fai clic senza rilasciare
e seleziona testo sono ora supportate quando si
registra un processo aziendale.

-- When you record a process with more than
1000 steps, the Recordings page now displays
the process without any delay. Previously, the
Recordings page took some time to load.

Limitazioni

Il programma di installazione della Control Room per Red Hat Enterprise Linux (versione 7.7 o 7.9)
non include il pacchetto Discovery Bot .
Soluzione: Log in to the Control Room as an admin, select Manage > Package > Upload and
upload the Discovery Bot package. Il pacchetto è incluso nell'elenco dei pacchetti predefiniti.

• Utenti di Cloud: Quando si crea un'opportunità con 50 passaggi, l'opzione Scarica PDD è
disabilitata e il PDD non è disponibile per il download.

• Utenti di On-Premises: Quando si crea un'opportunità con 100 passaggi, l'opzione Scarica
PDD è disabilitata e il PDD non è disponibile per il download.
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IQ Bot

Novità

Moduli standard IQ Bot
Crea istanze di apprendimento utilizzando moduli standard che utilizzano un modello preformato e
una classificazione esistenti per estrarre un numero elevato di campi dati da documenti strutturati
che in genere presentano una variazione minima o nulla nel layout.

Nota:  I moduli standard sono attualmente disponibili solo come funzionalità beta.

Using IQ Bot for standard forms alla pagina 2538

Ulteriori istanze di apprendimento per l'action Elabora documenti IQ Bot
Utilizza le nuove istanze di apprendimento Azure 3.2 e japanese_Tegaki per l'action IQ Bot
Elabora documenti nel package IQ Bot Extraction.
Utilizzo dell'action Elabora documenti IQ Bot alla pagina 1661

Cosa è cambiato

Percorsi dei file IQ Bot
Le posizioni dei file e i nomi delle cartelle vengono aggiornati per utilizzare il nuovo nome del
prodotto. Ad esempio:
• Il percorso di installazione predefinito viene modificato da C:\Program Files

 (x86)\Automation Anywhere IQ Bot A2019\ in C:\Program Files
 (x86)\Automation 360 IQ Bot\.

• Il percorso di log predefinito viene modificato da C:\Users\Public\Documents
\Automation Anywhere IQ Bot A2019 in C:\Users\Public\Documents
\Automation 360 IQBot Platform.

Colonna Fornitore nella pagina Istanze di apprendimento aggiornata
La colonna Fornitore nella pagina Istanze di apprendimento > Le mie istanze di
apprendimento è stata aggiornata per visualizzare un elenco di tutti i motori OCR disponibili
associati all'istanza di apprendimento corrispondente.

Miglioramenti al package IQ Bot Extraction
Il package IQ Bot Extraction supporta ora i seguenti motori OCR:
• Microsoft Azure Computer Vision OCR engine 3.2

Ciò migliora notevolmente l'estrazione OCR da documenti in lingua cinese.
• Motore OCR Tegaki API

IQ Bot Extraction package alla pagina 1654
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Cosa è cambiato

Miglioramento della sicurezza IQ Bot (ID caso Service Cloud: 00677507)
È ora possibile migliorare ulteriormente la sicurezza configurando la comunicazione IQ Bot
RabbitMQ v3.8.18 tramite un canale SSL/TLS sicuro. Set secureRabbitMQCommunication =
 true in the system.properties file and then restart all IQ Bot services, including RabbitMQ
v3.8.18. By default, this flag is set to false.
Questo miglioramento risolve anche un problema che causava una vulnerabilità della sicurezza di
RabbitMQ v3.8.18.

Riutilizzo del nome di un'istanza di apprendimento eliminata | Automation 360 IQ Bot
On-Premises
Durante la creazione o la modifica di una nuova istanza di apprendimento, è ora possibile riutilizzare
il nome di un'istanza di apprendimento eliminata. Assicurarsi di eseguire il backup dei documenti
nella cartella Output prima di eliminare un'istanza di apprendimento. È quindi possibile cancellare i
documenti della cartella Output prima di creare o modificare una nuova istanza di apprendimento
con lo stesso nome.
Se i documenti non sono stati cancellati dalla cartella Output per l'istanza di apprendimento
eliminata, non è possibile scaricare il contenuto. In ogni caso, è possibile scaricare solo i documenti
elaborati dalla nuova istanza di apprendimento.

Supporto per Microsoft Azure SMB
IQ Bot supporta ora il sistema di archiviazione dei file Microsoft Azure utilizzando il protocollo SMB
(Server Message Block). È ora possibile eseguire l'installazione di IQ Bot utilizzando la cartella
condivisa configurata con SMB e accedere ai file di output dalla stessa directory.

Passaggio da un database all'altro senza reinstallare IQ Bot
È ora possibile passare da un database configurato all'altro senza doverlo reinstallare IQ Bot
utilizzando l'utilità SwitchDBServer.bat.
Per utilizzare questa utilità, esegui queste operazioni:
1. Scarica ed estrai l'utilità SwitchDBServer.bat dalla cartella <IQBot installation Dir>

\Configurations, quindi apri il prompt dei comandi in questa directory.
2. Esegui il file batch (.bat) con un indirizzo IP o un nome host del server DB di destinazione.

Example: SwitchDBServer 171.xx.xx.11

La tabella seguente elenca le correzioni e le build in cui sono state corrette. La build 9642 è la build più
recente per On-Premises e include correzioni della build precedente.

Correzioni

Crea ID caso Service Cloud Descrizione

9596 00777932, 00766332 Durante l'aggiornamento a questa versione
di IQ Bot, il percorso di output della versione
precedente viene mantenuto durante
l'installazione.
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Correzioni

Crea ID caso Service Cloud Descrizione

9595 00686444 When exporting learning instances from
one environment to another, IQ Bot now
updates the visionBotId in the exported
data. Pertanto, puoi ora modificare i bots
nell'ambiente di destinazione senza errori.

9595 -- Le voci di riga della tabella duplicate nel
Validator sono ora notevolmente ridotte
grazie alla logica migliorata di estrazione
dalla tabella.

9595 00651057 IQ Bot può ora connettersi alla cache Ignite
della Control Room senza errori. Questo
risolve un problema a causa del quale tutte
le istanze di apprendimento non venivano
visualizzate.

9595 00616038 Quando si aggiorna o si riavvia la Control
Room, i messaggi di errore non vengono più
visualizzati quando si utilizza il collegamento
o si fa clic su Scopri IQ Bot per aprire IQ
Bot.

9595 00668412, 00644948, 00717414 Quando si carica un documento in
produzione, non si verificano più blocchi
nel sistema e i documenti vengono inviati
correttamente al Validator.

9595 00651572, 00650959 Se nella cartella Risultato/Riuscito
non sono disponibili file e fai clic sull'action
Scarica tutti i documenti, IQ Bot
visualizza ora il messaggio di errore corretto.

9595 -- I documenti in lingua cinese (semplificato)
vengono ora elaborati correttamente senza
problemi.

9595 -- Se si aggiunge una libreria bloccata a
una logica Python personalizzata e si fa
clic su Esecuzione di test per qualsiasi
campo, nella pagina Designer non viene più
visualizzato un messaggio di errore.

9595 -- Il comando IQ Bot Enterprise 11 può ora
essere migrato all'azione Carica documenti
in Automation 360 IQ Bot. Pertanto, non
è più necessario creare manualmente
bots quando si migrano le istanze di
apprendimento.
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Limitazioni

IQ Bot Cloud: If you do not access IQ Bot within the configured Ideal time out value set on the
IQ Bot server:
• Viene visualizzato un messaggio per il riavvio di IQ Bot.
• I Bots che utilizzano le API di IQ Bot non funzionano al riavvio del server.

Aggiornare la pagina Web di IQ Bot dopo un certo periodo di tempo (più di 5 minuti) per accedere a
IQ Bot.

Quando crei un'istanza di apprendimento, se il PDF caricato contiene caratteri piccoli, il documento
viene classificato come immagine. Se si utilizza OCR PDFBox per creare un'istanza di apprendimento
per un documento di più pagine, i segmenti non vengono visualizzati.
Soluzione: Spegnere PDFBox OCR.

Per un'istanza di apprendimento con moduli standard, quando si tenta di scaricare i file di output e
allo stesso tempo si inviano frequenti richieste API a tale database, il sistema potrebbe smettere di
rispondere.
Azione consigliata: Quando si utilizza l'istanza di apprendimento con moduli standard, attendere
il download dei file. Dopo il download, assicurarsi di aspettare un po' (> 60 secondi) tra le richieste
API.

Se viene utilizzata una configurazione errata per creare il file providerVersion di un'istanza di
apprendimento di moduli standard, viene visualizzato un messaggio di errore quando questa istanza
di apprendimento viene spostata in produzione.

Nota:  Assicurati di utilizzare configurazioni valide.

Se utilizzi un bot associato ad un'istanza di apprendimento di moduli standard per caricare un
numero elevato di documenti, alcuni documenti non verranno elaborati.
Soluzione: Poiché questo problema potrebbe essere causato da un timeout, provare a caricare i
documenti dopo un certo periodo di tempo.

Se hai utilizzato una versione precedente di IQ Bot (11.x) per spostare i documenti in Validator,
non è possibile scaricarli quando si esegue la migrazione a questa versione di Automation 360 IQ
Bot.
Soluzione: Se si sta effettuando la migrazione a questa versione, assicurati di cancellare tutti i
documenti in Validator.

Quando si utilizzano le azioni Scarica tutti i documenti o Carica documento dal package IQ
Bot, il caricamento e il download possono non riuscire poiché le impostazioni proxy specificate in
Control Room non vengono utilizzate.

Se si elimina manualmente ogni file .csv dalla cartella Success, è possibile che non vengano
scaricati altri file nella cartella quando si utilizza l'opzione Scarica.
Assicurati di non eliminare manualmente alcun file dalla cartella Success.

Solo l'autenticazione SQL è supportata quando si utilizza lo strumento Migration Assistant per
eseguire la migrazione da IQ Bot 11.x a Automation 360 IQ Bot.

Se disponi di un documento con un numero elevato di pagine (> 100), viene visualizzato un
messaggio di errore a intermittenza quando si fa clic su Guarda i risultati dell'estrazione per
un'istanza di apprendimento esistente.
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Limitazioni

Il conteggio dei documenti non classificati in Risultati di staging e Risultati di produzione
nella scheda Riepilogo di un'istanza di apprendimento potrebbe essere visualizzato in modo errato.

Sulla schermata del Validator, se vengono utilizzati valori errati per aggiornare un campo su cui
sono state applicate le convalide, non viene visualizzato un avviso quando si perde il focus del
campo.

Se uno dei campi numerici disponibili include parentesi o (), la regione identificata dal sistema (SIR)
selezionata nel pannello del documento diventa un trattino (-) quando si fa clic sul valore estratto.

Se si utilizza il nome di un'istanza di apprendimento eliminata durante la creazione di una nuova
istanza di apprendimento, entrambe le istanze vengono elencate nel menu a discesa Nome
dell'istanza di apprendimento dell'action Carica documento quando viene creato un bot.
Soluzione: Fare clic sulla nuova istanza di apprendimento per rimuovere la vecchia istanza di
apprendimento dall'elenco.

Se si utilizza Tesseract4 OCR durante gli aggiornamenti del package IQ Bot Extraction, si verifica un
ritardo nei tempi di elaborazione del documento e nella produzione dei risultati.

Per un'istanza di apprendimento creata con moduli standard, se l'estrazione non riesce per il
campo Opzioni del campo > Opzionale, Il valore impostato in Valore predefinito non viene
assegnato a quel campo del modulo.
Soluzione: Utilizzare lo script Python dalla scheda Logica per impostare il valore che deve essere
assegnato come Campo predefinito.

(ID caso Service Cloud: 00601790) Per i documenti elaborati con il package IQ Bot Extraction, i
dettagli del documento come Documenti elaborati e Pagine caricate non vengono visualizzati
correttamente nella pagina Dashboard.

As the Preview2 version of the Microsoft Azure 3.2 is deprecated, if you have used the Microsoft
Azure 3.2-Preview2 OCR engine to create a learning instance, the documents will be unclassified.
Soluzione: Ensure that you replace all occurrences of Microsoft Azure 3.2-Preview2 with Microsoft
Azure 3.2:
• In Azure3OCREngineSettings.json file, change Version: v3.2-preview.2 to Version:

v3.2. You can then update the OCR engine version by uploading this file to database using API
How to change OCR Settings in IQ Bot (A-People login required)

• In the IQ Bot Installation > Configurations folder, update
Azure3ContainerOCREngineSettings with Microsoft Azure 3.2. This is for the
containerized deployment of Microsoft Azure 3.2 OCR engine.

(ID caso Service Cloud: 00799842) When you process vector-based PDF documents in IQ Bot, the
OCR results are sometimes inaccurate. For instance, in some cases, spaces between words are
missed in the extracted data.This might happen because of reasons related to the document that
you uploaded or the tool that you used to generate the PDF file.
Soluzione: To process your vector-based PDF document successfully, perform either of the
following steps:
1. Convert your vector-based PDF document again to a vector-based PDF document by using a

tools such as Adobe Acrobat.
2. Convert your vector-based PDF documents to a raster file format, such as TIFF.
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Importante:  Per informazioni sui pacchetti supportati da questa versione, vedi View package versions
available in the Control Room alla pagina 2009.

Note su Enterprise Edition A2019.20
Data di rilascio: 20 April 2021

Riesaminate le novità e le modifiche, le correzioni e le limitazioni della versione Enterprise A2019.20. Build
8846 è per Cloud e Build 8815 è per On-Premises. IQ Bot A2019 è nella Build 8815.

Importante:  Abbiamo aggiornato la build Cloud per includere le seguenti correzioni:
• Mancata esecuzione della migrazione dei bots a causa di un errore di pre-elaborazione (ID caso Service

Cloud 00760877, 00761211)
• Impossibilità di distribuzione dei bots perché il percorso risorse supera la lunghezza massima supportata

da Microsoft (ID caso Service Cloud 00764731, 00763373, 00765172, 763334)

• Migrazione
11.x e 10.x | solo 11.x

• Enterprise A2019
Novità | Cosa è cambiato | Correzioni | Limiti

• AARI
Novità | Cosa è cambiato | Correzioni | Limiti

• Discovery Bot
Novità | Cosa è cambiato | Correzioni | Limiti

• IQ Bot
Novità | Cosa è cambiato | Correzioni | Limiti

• Bot Insight
Novità

Aggiornamento a questa versione
È possibile eseguire l'aggiornamento a questa versione dalle tre precedenti versioni (ovvero n−3, dove n si
riferisce all'ultima versione). Le seguenti build sono certificate per l'aggiornamento a questa versione:
• Build 8147 (v.19)
• Build 7560 (v.18)
• Build 7103 (v.17)

Per i dettagli su come eseguire l'aggiornamento, consultare Aggiornamento alla versione di Automation 360 più
recente alla pagina 1063.

Recommendation:  Se non si utilizza una versione n−3, eseguire l'aggiornamento a una delle tre versioni
certificate prima di eseguire l'aggiornamento a questa versione.

Importante:  This release includes a required update to your . Ensure that you complete the update to
continue with your automation activities when upgrading from a previous release to this release.
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Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina
1043

To verify which  version is compatible with this release, see Compatibility with release builds alla pagina
1026.

Funzionalità di migrazione

Enterprise 11 e Enterprise 10 funzionalità

Selezione delle cartelle per la migrazione (ID caso Service Cloud: 00689307)
In Bot Migration Wizard, è ora possibile selezionare le cartelle che contengono bots (TaskBots
e MetaBots) che si desidera migrare a Enterprise A2019. Di conseguenza, non è più necessario
eseguire la migrazione di singoli bots da tale cartella.

Esegui la migrazione dei MetaBots con le schermate
Migrare MetaBots che contengono schermi come asset. È possibile eseguire la migrazione di
schermate basate su HTML, MSAA, Java, tecnologie .Net e utilizzare le variabili delle credenziali.

Migrazione di bots che utilizzano i seguenti attributi
• Bots che contengono il comando SE > Logica riuscita o SE > Logica non riuscita e questi

comandi restituiscono una variabile come output
• Bots che contengono il comando Run Task con l'opzione Ripeti fino a interruzione per l'action

Esegui nel package TaskBot
• Bots che utilizzano la variabile di sistema $Clipboard$ come variabili di input e output per

trasferire il valore alla logica MetaBot

Funzionalità esclusive di Enterprise 11

Migrazione di bots che utilizzano BAPI SAP per automatizzare le attività relative a SAP
Esegui la migrazione dei bots utilizzando BAPI SAP per automatizzare le attività relative a SAP. I
comandi SAP vengono migrati in azioni equivalenti della BAPI SAP package e il nome utente, la
password e gli attributi del nome host utilizzati per connettersi al server SAP in bots Enterprise 11
vengono migrati come variabili di credenziali in Enterprise A2019.

Mantenere il comportamento legacy della variabile di sistema $Excel Cell Row$
Utilizza l'opzione Usa il comportamento legacy della "Riga Cella Excel" in Bot Migration
Wizard per mantenere il comportamento legacy della variabile di sistema $Excel Cell Row$ utilizzata
nei bots creati in versioni precedenti alla Version 11.3.1 dopo la migrazione a Enterprise A2019.

© 2023 Automation Anywhere. All rights reserved.     414



    Automation Anywhere - Learn

Funzionalità esclusive di Enterprise 11

Migrazione di bots con i seguenti attributi:
• Bots che utilizzano il comando Elimina o Ottieni tutti i messaggi per eliminare o

scaricare allegati da tutte le e-mail che utilizzano Exchange Web Services (EWS) utilizzando
l'autenticazione OAuth.

• Bots che contengono oggetti acquisiti utilizzando il comando Object Cloning basato su Firefox e
sulle tecnologie Silverlight

• Bots che utilizzano il comando Modifica utente con le opzioni Aggiorna account e Modifica
password nel comando Active Directory

• Bots che utilizzano l'opzione Crea utente nel comando Active Directory
• Bots che utilizzano il comando Variable Operation e l'opzione Configurazione decimale è

selezionata
• Bots che utilizzano la variabile di sistema $AATaskExecutor$
• Bots dalla Version 11.3.5 o successiva che utilizzano il comando Ottieni cella singola con le

opzioni Cella specifica e Ottieni valore cella selezionate per recuperare il valore da una cella
in un file Microsoft Excel.

Enterprise A2019

Novità

Supporto per indirizzi IPv6
Puoi installare Enterprise A2019 in modalità cluster di bilanciamento del carico distribuito in
una rete IPv6 per soddisfare i requisiti di infrastruttura e sicurezza delle informazioni della tua
organizzazione.
Non sono supportati:
• La posizione geografica non è disponibile per gli indirizzi IPv6.
• Gli indirizzi locali dei collegamenti per gli indirizzi IPv6 sono rimossi dall'elenco IPv6 del

programma di installazione di Enterprise A2019.

Configura cluster IP alla pagina 917

Commutare la registrazione del dispositivo tra istanze di Control Room
È ora possibile commutare la registrazione del dispositivo tra più istanze di Control Room senza
reinstallare Bot Agent. Questa impostazione è applicabile a singoli dispositivi utente installati a
livello di sistema o di utente.
Commutare la registrazione del dispositivo tra istanze di Control Room alla pagina 2734 | Switch Bot
Agent to a different Control Room alla pagina 1045

Nuova autorizzazione per attestare il nome utente del dispositivo (ID caso Service Cloud:
00576058)
Utilizza la nuova autorizzazione per assegnare un dispositivo predefinito a un nome utente per
ignorare la convalida delle credenziali quando si distribuisce un bot su Bot Runners non assistiti.
L'autorizzazione è applicabile agli utenti predefiniti del dispositivo con una sessione utente sbloccata
e attiva.
Autorizzazioni per le funzioni di un ruolo alla pagina 2694
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Novità

Impostazioni delle soglie delle risorse per ottimizzare le distribuzioni di bot
Configura le impostazioni di soglia delle risorse in Control Room in modo che il sistema distribuisca
il bot successivo solo quando le risorse del sistema sul dispositivo rientrano nelle soglie specificate.
Specifica le impostazioni a livello di Control Room per tutti i dispositivi e personalizzarle a livello di
dispositivo.
Manage device settings alla pagina 2727

Riduzione dei tempi di avvio dei bot
È ora possibile ridurre il tempo di avvio dei bot utilizzando le impostazioni di Control Room per
precaricare i pacchetti utilizzati più di frequente nell'automazione su tutti i dispositivi utente quando
si connettono a Control Room.
Automatic package updates for Cloud Control Room alla pagina 2727

Coda Express nell'automazione del carico di lavoro
È ora possibile creare rapidamente code di automazione dei carichi di lavoro con parametri
predefiniti in Control Room utilizzando l'opzione Crea coda Express nella pagina Code.
Creazione di code Express alla pagina 2801

Filtri di gruppo per gli utenti Active Directory
È possibile fornire filtri aggiuntivi per la directory Utenti come parte del file um.properties.
Di conseguenza, è possibile filtrare i gruppi di sicurezza presenti nella directory Utenti per la
mappatura dei ruoli in Control Room.
Manage Active Directory role mapping alla pagina 2715

Automatizzate le attività relative a SAP utilizzando BAPI SAP
Utilizza le actions disponibili in BAPI SAP package per automatizzare le attività relative a SAP tramite
BAPI SAP.
BAPI SAP package alla pagina 1831

Nomi predefiniti per le variabili di output
Quando si configura una variabile di output per i seguenti packages, il Control Room mostra un
nome descrittivo della variabile predefinita. Se si creano diverse variabili di output, i nomi delle
variabili successive vengono aggiunti con -1, -2, -3 e così via per evitare la duplicazione.
• Browser
• CSV/TXT
• Email
• Excel advanced
• JavaScript
• Loop
• Recorder
• VBScript
• Window
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Novità

Dividi PDF con pagine vuote supporta la scansione di documenti di immagini (Service
Cloud case ID: 00683923)
Utilizza l'action Dividi PDF per separare una pagina vuota dalle pagine con immagini acquisite.
Con la suddivisione basata su pixel, puoi ora utilizzare Dividi documento per dividere un PDF con
separatori di pagine vuote di documenti acquisiti (basati su immagini).

Intervallo di porte SMTP ampliato per includere le porte da 1 a 65535
Il package Email supporta ora porte comprese tra 1 e 65535 per il server SMTP. Ora puoi utilizzare
l'action Invia configurando la porta SMTP in questo intervallo.

Nuove actions in package Active Directory
• Aggiorna opzioni account: consente di impostare gli attributi di account per l'utente.
• Modifica password utente: utilizza questa opzione per modificare la password di un utente.

User account operations alla pagina 1386

Miglioramento dell'action Crea utente nel package Active Directory
È ora possibile utilizzare l'action Crea utente per creare un utente Active Directory con password.
Using the Create user action alla pagina 1388

Supporto esteso e nuove funzionalità per Universal Recorder
Utilizza Universal Recorder per eseguire le seguenti operazioni:
• Automatizzare i clic e il recupero dei dati negli elenchi a discesa e nelle caselle combinate delle

applicazioni Oracle EBS come Compass.
• Collegare un oggetto che il bot non è in grado di identificare in modo affidabile a un oggetto

vicino (ad esempio un collegamento o un pulsante) più facile per il bot da trovare. Utilizzare
questa funzione nelle applicazioni MSAA, UI Automation o Java.

Supporto di nuove lingue con nomi variabili
Ora è possibile utilizzare caratteri cechi, danesi, olandesi, finlandesi, francesi, tedeschi, ungheresi,
italiani, norvegesi, polacchi, portoghesi, rumeni, spagnoli e svedesi nei nomi delle variabili.
Unicode range supported in variables alla pagina 2036

Cercare e aggiungere il bot figlio al bot padre
Cercare un bot figlio in spazi di lavoro pubblici e privati in modo da poterlo aggiungere al bot padre.
È possibile cercare il bot figlio con Bot editor e l'action Esegui del package Task Bot.
Using the Run action alla pagina 1896 | Bot editor for creating bots alla pagina 1358

Ottenere informazioni sull'utente che ha distribuito il bot
Use the AATaskInvoker system variable to return the username, first name, last name, and email of
the user that ran or scheduled the bot. Se il bot viene distribuito su un Bot Runner assistito, questa
variabile restituisce informazioni sull'utente connesso. Se il bot viene distribuito da un trigger,
questa variabile restituisce informazioni sull'utente associato a tale licenza .
System settings and parameters alla pagina 2025
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Novità

Miglioramenti al ripristino Git
• Se il database viene eliminato o danneggiato, come amministratore puoi ora ripristinare i file

dall'archivio Git in un archivio non completamente vuoto.
• È inoltre possibile sovrascrivere o ignorare i file se si dispone di file duplicati nell'archivio Git.
• Se ripristini i file in un archivio vuoto, puoi scegliere di utilizzare le credenziali esistenti

(configurate con Control Room) o le credenziali di qualsiasi altro archivio.

Ripristino di bots da archivio Git alla pagina 2761

Visualizzare la cronologia delle versioni di TaskBots
Puoi ora visualizzare la cronologia delle versioni dei tuoi TaskBots per identificare le modifiche
rilevanti eseguite da altri utenti ai tuoi TaskBots in una data e un orario specifici insieme ai
messaggi di archiviazione.
Visualizzare la cronologia delle versioni di TaskBot alla pagina 2005

Supporto per un archivio chiave esterno
Utilizza gli archivi chiave esterni per archiviare e recuperare le credenziali in modo sicuro utilizzando
un gestore di chiavi di terze parti come CyberArk e AWS Secrets Manager. External Key Vault
support for AWS Secrets Manager and CyberArk for Bootstrap (database credentials,) and System
(Service account credentials, Active Directory service account credentials, and SMTP credentials).
Integrate external key vaults alla pagina 907

Nuova condizione in Se package (ID caso Service Cloud: 00536088, 00690073, 00717514,
00737243, 00702383)
Utilizza la nuova condizione La finestra con lo stesso titolo non esiste o Esiste una finestra
con lo stesso titolo disponibile nel package Se per verificare se esiste una finestra con lo stesso
titolo o se il titolo della finestra è cambiato.
If package alla pagina 1625

Google packages sono ora disponibili
I packages Google Calendar, Google Drive e Google Sheets sono ora generalmente disponibili in
Enterprise A2019, con una modifica importante al metodo di autenticazione:
• Ogni package Google contiene un'action Connetti per autenticare il tuo account prima di

aggiungerne altre actions dal package in questione all'automazione. Questa action sostituisce la
ormai obsoleta OAuth action del package G-App.

• Ogni package Google contiene un'action Disconnetti per terminare la connessione.

Utilizzo dell'azione Connetti per i pacchetti Google alla pagina 1600

Cosa è cambiato

I Bots attendono Internet Explorer per effettuare il rendering completo nel in Mouse
package
I Bots (inclusi bots migrati da Enterprise 11) che utilizzano il package Mouse attendono ora che
Internet Explorer abbia completato il caricamento della pagina prima di eseguire l'action Fai clic.
Questo evita che i bots non funzionino durante il caricamento della pagina.
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Cosa è cambiato

Modifica dell'interfaccia nella finestra Modifica variabile
Quando si modifica una variabile, deselezionando la casella di controllo Usa come input, Usa
come output o Costante (sola lettura), un messaggio informa ora l'utente dell'impatto di
questa modifica e richiede di confermare l'aggiornamento.

Miglioramento delle voci del registro di audit  (ID caso Service Cloud: 00656155)
Le voci del registro di audit sono state migliorate per visualizzare Nome elemento e Tipo di
evento per le richieste di importazione, esportazione, check-in e check-out.

File .atmx non scaricato durante la migrazione
Il processo di migrazione non scarica ora il file .atmx se il bot associato è utilizzato come bot figlio
nel bot padre. L'action Scarica file di CR dal package File non viene più aggiunto nel bot migrato
per scaricare il file dipendente bot.atmx durante la migrazione.

Possibilità di aggiornare la versione del package Recorder o di eseguire il downgrade a
un'estensione Google Chrome precedente
I Bots che utilizzano la versione 2.0.5 o precedente del package Recorder per l'automazione nel
browser Google Chrome, devono ora essere aggiornati per utilizzare una versione più recente della
2.0.5 del package Recorder. Questo è necessario solo per i dispositivi Bot Runner con la nuova
estensione Google Chrome (ID:kammdlphdfejlopponbapgpbgakimokm) installata e che non hanno
eseguito in precedenza bots che utilizzano la versione 2.0.5 o precedente del package Recorder.
Se non desideri aggiornare il package Recorder, puoi installare manualmente la vecchia estensione
Google Chrome. Consulta Google Chrome extension troubleshooting alla pagina 1960.

La tabella riportata di seguito elenca le correzioni apportate e le build in cui sono state implementate. Build
8846 è la build più recente per Cloud e include correzioni delle build precedenti. On-Premises è nella Build
8815.

Build 8846

ID caso Service Cloud Descrizione

00764731, 00763373, 00765172, 763334 È ora possibile distribuire bots e file dipendenti
archiviati in un archivio con un percorso di file che
supera la lunghezza massima dei caratteri supportata
(256 caratteri) per il sistema operativo Windows.

00714248 Solo i Bot Runners e i Bot Creators espressamente
configurati come archivio credenziali per un
determinato bot possono utilizzare questo bot.

00751728 Quando si esegue la migrazione di bots Enterprise
11 che usano il comando String Operation con il
carattere spazio come delimitatore, il valore estratto
conserva ora lo spazio e funziona correttamente. In
precedenza, dopo la migrazione, lo spazio veniva
rimosso dal comando String Operation.

© 2023 Automation Anywhere. All rights reserved.     419



    Automation Anywhere - Learn

Build 8846

ID caso Service Cloud Descrizione

00760877, 00761211 I Bots sottoposti a migrazione, modifica e
pianificazione vengono ora distribuiti correttamente
senza errori di pre-elaborazione. In precedenza, i
bots migrati non potevano essere eseguiti a causa del
seguente errore di pre-elaborazione: Il tipo di
attributo ANY non è supportato.

Build 8840

ID caso Service Cloud Descrizione

00747869, 00750571, 0744918 Quando si crea un bot utilizzando un loop con l'azione
Acquisisci Registratore per eseguire operazioni sul
browser Chrome, il bot ora viene eseguito senza
interruzioni. In precedenza, il bot non poteva essere
eseguito e visualizzava un errore.

00733635, 00743082, 00750865 Quando si esegue un bot che contiene l'azione di
Excel avanzato > Trova, la cella trova è ora attiva e le
azioni successive possono eseguire operazioni su di
essa.

00723075, 00717920 Quando un bot incontra una cartella di lavoro che
contiene collegamenti a celle di altre cartelle di
lavoro, il sistema rimuove il messaggio a comparsa di
Excel in modo che il bot possa essere eseguito senza
interruzioni.

00746651, 00757879 Dopo la migrazione dei bot, è possibile eseguire
correttamente i bot senza errori di pre-elaborazione.
In precedenza, l'utilizzo di variabili tra parentesi non
consentiva l'elaborazione dell'attività.

00742159, 00743092 Le azioni Imposta cella ed Elimina cella di Excel
avanzato selezionano ora le celle corrette quando il
nome della colonna dell'indirizzo della cella contiene
più di una lettera.

00743636 Le azioni Imposta cella, Elimina cella e Vai alla cella
di Excel avanzato supportano ora tutti gli intervalli.
In precedenza, le azioni riscontravano errori con
intervalli superiori a AB1:AB100.

00726030 I Bots possono ora utilizzare Recorder per acquisire
oggetti che contengono caratteri non validi in XML.

Build 8815

ID caso Service Cloud Descrizione

00750668 Un bot carico di lavoro non è più bloccato in una coda
e il dispositivo non visualizza lo stato Scelto in
fase di esecuzione.
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Build 8815

ID caso Service Cloud Descrizione

00733227 Le tabelle di database Control Room vengono create
quando si utilizza il database 11.x ripristinato durante
l'installazione di Enterprise A2019.

00733720 Bot Migration Wizard non riscontra più errori durante
l'elaborazione di un bot di grandi dimensioni per
la migrazione. In precedenza, questo problema si
verificava quando un bot di grandi dimensioni veniva
scaricato sul dispositivo Bot Runner per la migrazione
da Control Room e la connessione tra il dispositivo
Bot Runner e Control Room veniva ripristinata.

-- Bot Scanner è stato ora aggiornato per includere gli
scenari che in precedenza non funzionavano dopo la
migrazione. Di conseguenza, alcuni bots potrebbero
essere stati spostati dall'elenco di bots che possono
essere migrati all'elenco dei bots che non possono
essere migrati nel report di output. Ciò può ridurre
il numero di bots che possono essere migrati a
Enterprise A2019.

00703679, 00711398, 00729399 I bots Enterprise 11 o Enterprise 10 che utilizzano la
variabile stringa o un oggetto acquisito da Internet
Explorer la cui proprietà è nulla o vuota, non riscontra
più un errore dopo la migrazione dei bots.

00667326 Bot Scanner non si blocca più quando si esegue la
scansione dei bots per uno dei seguenti motivi:
• Scansione di un file .atmx danneggiato di un bot
• Bots che contengono il comando If, IF/ELSE o

Loop e tale comando viene commentato
• Bot che contiene un oggetto acquisito utilizzando

il comando Object Cloning comando utilizzando la
modalità di riproduzione Coordinata e sul quale
viene eseguita l'azione Fai clic

00731068, 00737025 Non si verifica più un errore quando si esegue un bot
che contiene più variabili che restituiscono un valore
numerico nello stesso comando dopo che il bot è
stato migrato.

00720261 Non si verifica più un errore quando esegui la
migrazione di un bot con un nome di credenziale
che contiene un carattere di spazio o un carattere
speciale.

00713303 In un bot migrato che utilizza il comando Run
Task, quando si esegue una sottoattività all'interno
dell'attività principale e il nome della sottoattività
contiene caratteri Unicode, il bot viene ora eseguito
correttamente senza errori. In precedenza, il bot non
funzionava per un errore.
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Build 8815

ID caso Service Cloud Descrizione

00691133 Ora puoi eliminare bots migrati nella tua area di
lavoro privata senza alcun problema. In precedenza,
veniva visualizzato un messaggio di errore quando
un bot migrato veniva eliminato nell'area di lavoro
privata.

00736166 In precedenza, quando veniva avviato il processo
di migrazione, questo a volte rimaneva nello In
corso nel Bot Migration Wizard. Ora il processo
viene avviato.

00730131 I Bots che utilizzano il comando Run Script con la
variabile di sistema $Clipboard$ come variabile di
input o output non presentano più errori quando
vengono eseguiti tali bots dopo la migrazione a
Enterprise A2019.

00726833 Work Items Enterprise 11 e code associate a
bots che utilizzano il comando Variable Operation
non presentano più un errore dopo che il primo
elemento nella coda è stato elaborato correttamente
successivamente alla migrazione a Enterprise A2019.

-- Bot Scanner non presenta più un errore mentre si
sta effettuando la scansione di MetaBots contenenti
il comando Object Cloning commentato e il MetaBot
sta tentando di rilevare la modalità di riproduzione da
questi comandi commentati.

00716557 Non viene più rilevato un errore quando si esegue in
Enterprise A2019 un MetaBot creato in Enterprise 10,
migrato a Enterprise 11 e quindi migrato a Enterprise
A2019.

00710569 Durante la migrazione di un MetaBot che contiene
schermate come risorse da Enterprise 11 a Enterprise
A2019, i caratteri giapponesi nelle proprietà
dell'oggetto vengono ora visualizzati correttamente
nei bots migrati. In precedenza, i caratteri giapponesi
nelle proprietà dell'oggetto erano confusi nei bots
migrati.

00702262 La pagina Cronologia attività ora mostra un
messaggio di errore dettagliato che specifica la causa
dell'errore e la riga in cui si trova per i bots migrati
da Enterprise 11 e che utilizzano il comando Error
Handling.
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Build 8815

ID caso Service Cloud Descrizione

00703513, 00708988 I bots padre che utilizzano l'action Esegui del
package Task Bot con l'opzione In caso di errore,
avvia la ripetizione successiva selezionata non
riscontrano più un errore se i bots figlio riscontrano
un errore durante l'esecuzione e non restituiscono
la variabile di output al bot padre. In precedenza, i
bots padre riscontravano un errore se i bots figlio non
restituivano la variabile di output ai bots padre perché
i bots figlio avevano riscontrato un errore durante
l'esecuzione.

00702601 Un bot che utilizza una variabile matrice che contiene
una variabile di sistema e che restituisce un numero
intero non rileva più un errore dopo la migrazione di
tale bot.

00707801 È ora possibile migrare un bot Enterprise 11 che
contiene il Mouse Fai clic per acquisire le coordinate
di una finestra ingrandita. Previously, the bot with a
Mouse Click encountered an issue during migration
because the window left and top parameters were set
to negative values for maximized windows.

00710315, 00728228, 00729082, 00744242 I bots migrati che utilizzano il comando Object
Cloning con tecnologia legacy per catturare oggetti
con più righe di testo ora funzionano correttamente,
senza problemi.

00716650 Quando si esegue la migrazione di un bot Enterprise
11 che contiene un comando Excel contenente due
sessioni Excel, le actions Ottieni nome colonna o
Ottieni numero riga ora visualizzano i valori corretti
nell'output. In precedenza, le actions impostavano
valori di sessione errati nel bot migrato, se questo
conteneva due sessioni Excel.

00711148 L'installazione di Enterprise A2019 non fallisce
più se il percorso dei dati e di log contiene uno
spazio (ad esempio D:\Automation Anywhere
\ProgramData). Inoltre, non viene più visualizzato
il seguente messaggio di errore: Impossibile
creare le tabelle del database della
Control Room.

00708902 Ora puoi utilizzare il package Google Drive per
caricare i file nell'unità condivisa di Google. Utilizza
solo l'opzione ID cartella per caricare i file in una
cartella condivisa nell'unità e immettere l'ID della
cartella condivisa. In precedenza, si verificava un
errore quando l'utente tentava di caricare un file nella
cartella condivisa in Google Drive.
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Build 8815

ID caso Service Cloud Descrizione

00735479 Quando si crea un bot che ha una dipendenza con
un lungo percorso di archiviazione superiore al limite
massimo di 256 caratteri e quando si esegue il bot
sul computer Bot Runner, il bot viene ora visualizzato
un messaggio che richiede di ridurre la lunghezza del
percorso del file. In precedenza, l'esecuzione del bot
non andava a buon fine senza che alcun messaggio
indicasse il motivo dell'errore.

00727406 Ora è possibile inviare un'e-mail in formato HTML
con un allegato HTML utilizzando il Server e-mail.
In precedenza, quando un'e-mail veniva inviata
in formato HTML insieme a un file HTML allegato,
il corpo dell'e-mail e il contenuto del file allegato
venivano uniti. Di conseguenza, solo l'allegato veniva
visualizzato nella e-mail senza il contenuto del corpo.

00707734 Nel package App Integration, quando si utilizza
l'action Acquisisci il testo della finestra in un
browser giapponese, il titolo della finestra viene ora
visualizzato correttamente per la lingua giapponese.
In precedenza, l'output non veniva visualizzato
correttamente nel formato di testo giapponese.

00699149,00707670 È ora possibile utilizzare l'action Decomprimi
del package Folder ed eseguire i bots su un
server Windows 10. Ora, se due utenti Windows
con credenziali diverse del dispositivo tentano
di distribuire un bot sullo stesso computer, la
distribuzione non fallisce. In precedenza, se un utente
distribuiva il bot sullo stesso computer con un profilo
utente diverso, l'esecuzione del bot non riusciva.

00695224, 00730472, 00739431 Quando si utilizza l'action Trova l'immagine nella
finestra nel package Image Recognition, i file
immagine vengono eliminati dalla posizione Temp
e lo spazio di archiviazione viene liberato dopo
l'esecuzione del bot. In precedenza, i file di immagine
non venivano eliminati dalla posizione Temp e, di
conseguenza, lo spazio di archiviazione su disco si
esauriva.

00709162 L'action CSV/TXT Apri funziona ora senza riscontrare
alcun problema, anche se sono presenti valori vuoti
nell'ultima riga del file .txt. In precedenza, se
nell'ultima riga del file erano presenti valori vuoti, il
bot riscontrava un problema.
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00711124 Nel package Email, quando utilizzi l'action Connetti,
aggiungi un loop e seleziona Per ogni mail nella
casella di posta per leggere le e-mail come
opzione Iteratore, una nuova riga non verrà più
eliminata e sarà possibile visualizzare correttamente
il contenuto delle e-mail. In precedenza, le nuove
righe venivano eliminate quando il messaggio veniva
inviato e ricevuto in formato testo normale.

00673049 Nel package SAP, se si verifica un errore quando
si utilizza l'action Connetti per connettersi a un
sistema SAP, l'errore viene ora acquisito nei blocchi
Prova e Cattura. In precedenza, il problema di
connessione non veniva rilevato nei blocchi Prova e
Cattura dell'action.

00697215 Un bot viene ora eseguito correttamente quando
si utilizza l'action Lancia con un'espressione.
In precedenza, quando un'espressione come
$number.ToString$ veniva utilizzata nel campo
Messaggio di eccezione dell'action Lancia, il bot
riscontrava un errore di pre-elaborazione.

00714260 Gli errori di runtime non vengono più visualizzati
quando si utilizzano:
• MetaBot che eseguono una funzione di migrazione

DLL che richiede più di un tipo di parametro come
Array (matrice) o qualsiasi tipo diverso da Stringa

• TaskBot che eseguono una logica che richiama un
bot figlio che assume più di un parametro di input
di tipo Matrice, mappato a una variabile Elenco
nella funzione di migrazione logica di esecuzione
del bot padre

00704547 L'action Pausa del package TaskBot ora funziona
correttamente quando viene utilizzata come ultima
attività nel bot. In precedenza, il bot non aspettava
il completamento dell'attività se l'action Pausa era
stata utilizzata come ultima attività nel bot.

00675344 Un TaskBot ora funziona meglio se si utilizzano le
actions Terminal Emulator Invia testo e Invia
chiave per eseguire un bot. In precedenza, il
TaskBot impiegava molto tempo per completare
l'esecuzione.
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00699650,00716648 Quando si utilizzano le actions Image Recognition
per eseguire un bot e il bot non funziona durante
l'esecuzione, le immagini di origine e di destinazione
acquisite vengono memorizzate in C:\ProgramData
\AutomationAnywhere\BotRunner\Logs
\IR con un massimo di 10 coppie di immagini di
origine e di destinazione. Ora, quando si raggiunge il
massimo, le coppie di immagini più vecchie vengono
sovrascritte con nuove immagini. In precedenza, i
registri delle immagini non venivano sovrascritti.

00716817 Un bot viene ora eseguito correttamente quando si
utilizza l'action PDF Estrai testo per estrarre il testo
strutturato dai file PDF. In precedenza, l'esecuzione
del bot non riusciva a estrarre il testo strutturato se
questo conteneva caratteri tailandesi.

00717204 È ora possibile utilizzare una credenziale da
Credential Vault nel campo URI delle actions REST
Web Service.

00682726, 00678580, 00695359, 00684985 Ora è possibile utilizzare Universal Recorder
per automatizzare le applicazioni Oracle Fusion
Middleware. In precedenza, un problema con l'API
Java faceva in modo che il registratore selezionasse
l'intera finestra invece dell'oggetto specifico.

00693770 Risolto un problema a causa del quale i numeri
estratti da un database SQL in una variabile tabella
dati venivano automaticamente convertiti in
notazione scientifica.

00669959 You can now select the same start date and end date
when you schedule bots with the Run repeatedly
option (Activity > Scheduled > Schedule bot) in
the Control Room.

00702841, 00700915 Disconnected devices are now displayed in the
Control Room (Devices > My Devices) when you
filter the devices list by Status as Disconnected.

00707318, 00711529 Gli elementi di lavoro in una coda attiva vengono ora
elaborati e non è più necessario eliminare la coda
attiva e creare un'altra coda dopo l'aggiornamento da
una versione precedente a questa versione.

00705046 I Bots che includono file dipendenti incorporati invece
di una cartella compressa non vengono più messi in
coda in modo intermittente per la distribuzione su
dispositivi Bot Runner.
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-- Gli ID tenant disattivati o i tenant rimossi che
vengono successivamente riutilizzati nella stessa
distribuzione con un tenant diverso potrebbero
generare un errore di licenza. Questo conflitto è
stato ora rimosso e i tenant rimossi in un successivo
riutilizzo non generano più l'errore.

00685926 Quando si importa un bot esportato nell'area di
lavoro privata e si esegue l'archiviazione del bot, il
bot importato viene ora sottoposto ad archiviazione
correttamente, senza problemi. In precedenza,
l'archiviazione non andava a buon fine a causa di un
errore di convalida dei metadati.

00682025 Quando un bot o un file viene modificato nell'area di
lavoro pubblica, il file dipendente clonato nell'area di
lavoro privata riflette ora le modifiche e l'esecuzione
del bot avviene correttamente. In precedenza, il
file dipendente clonato non rifletteva le modifiche e
l'esecuzione del bot non andava a buon fine.

00726018 L'action di Google Drive Carica file carica ora i file
nelle sottocartelle.

00715080, 00731152 È ora possibile eseguire la distribuzione di
bot non assistiti concorrenti su un dispositivo
multiutente con più sessioni utente in esecuzione
contemporaneamente.

-- Un utente Bot Agent non amministratore rimane
ora connesso a Control Room senza essere
frequentemente disconnesso.

00709737 Le Actions nel package Google Sheets supportano ora
fogli di lavoro contenenti celle vuote.

00710354 Non viene più visualizzato un errore di eccezione di
ibernazione quando si accede a Control Room come
utente Admin (amministratore).

00732178 È ora possibile eseguire l'estrazione dei bots da
cartelle con nomi simili ma in lettere maiuscole e
minuscole diverse e modificare i bots nell'area di
lavoro privata in Control Room.
Ad esempio, se nell'area di lavoro pubblica sono
presenti una cartella denominata Automation1 e
nell'Automation1 e nell'area di lavoro privata una
cartella denominata automation1, è possibile eseguire
l'Automation1, è possibile eseguire l'estrazione dei
bots dalla cartella Automation1 nell'area di lavoro
pubblica.
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-- I Bots vengono ora distribuiti su un dispositivo
multiutente in una sessione utente non
amministratore quando sul dispositivo è attiva anche
un'altra sessione utente amministratore se l'accesso
automatico a Control Room è impostato in modo da
bloccare la sessione al termine dell'esecuzione del bot
in una sessione sbloccata esistente.

00719407 Durante l'installazione cluster di Enterprise A2019
su Red Hat Enterprise Linux, il programma di
installazione utilizza ora lo stesso ID utente per tutti i
nodi del cluster.

00703325 L'autorizzazione del file di registro per una Control
Room installata su Linux viene ora mappata all'utente
crkernel. In precedenza, veniva mappata all'utente
radice.

-- Quando si accede a Control Room con l'opzione
Accedi con Windows selezionata, è ora necessario
immettere il FQDN per effettuare l'accesso.

00732141, 00722919, 00743006 Quando si precarica un package, una volta
completato il download, lo stato di completamento
viene aggiornato nella pagina Attività > Cronologia
attività e il record in sospeso non viene più
visualizzato nella pagina Attività > In corso.

00731376 Quando si esegue la migrazione della logica MetaBot,
se il nome della variabile e la variabile di mappatura
non corrispondono, le variabili non vengono più
create due volte. Di conseguenza, quando si esegue
l'operazione non viene più visualizzato un errore di
pre-elaborazione.

Ora, la migrazione della logica di esecuzione con
variabili CV è supportata.

Ora, quando si utilizza la variabile di sistema Data
nel comando cartelle File, il bot migrato non riscontra
più errori.

Quando si esegue la migrazione di bots (da v11.x
ad A2019) con proprietà OC superiori a 64 KB, tali
proprietà verranno troncate e il bot verrà migrato.

La tabella seguente elenca le correzioni e le build in cui sono state corrette. Build 8846 è la build più
recente per Cloud e include correzioni delle build precedenti. On-Premises è nella Build 8815.
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8846 00764731,
00763373,
00765172,
763334

È ora possibile distribuire bots e file dipendenti archiviati in un
archivio con un percorso di file che supera la lunghezza massima
dei caratteri supportata (256 caratteri) per il sistema operativo
Windows.

8846 00714248 Solo i Bot Runners e i Bot Creators espressamente configurati
come archivio credenziali per un determinato bot possono
utilizzare questo bot.

8846 00751728 Quando si esegue la migrazione di bots Enterprise 11 che
usano il comando String Operation con il carattere spazio come
delimitatore, il valore estratto conserva ora lo spazio e funziona
correttamente. In precedenza, dopo la migrazione, lo spazio
veniva rimosso dal comando String Operation.

8846 00760877,
00761211

I Bots sottoposti a migrazione, modifica e pianificazione vengono
ora distribuiti correttamente senza errori di pre-elaborazione.
In precedenza, i bots migrati non potevano essere eseguiti a
causa del seguente errore di pre-elaborazione: Il tipo di
attributo ANY non è supportato.

8840 00747869,
00750571,
0744918

Quando si crea un bot utilizzando un loop con l'azione Acquisisci
Registratore per eseguire operazioni sul browser Chrome, il bot
ora viene eseguito senza interruzioni. In precedenza, il bot non
poteva essere eseguito e visualizzava un errore.

8840 00733635,
00743082,
00750865

Quando si esegue un bot che contiene l'azione di Excel avanzato
> Trova, la cella trova è ora attiva e le azioni successive possono
eseguire operazioni su di essa.

8840 00723075,
00717920

Quando un bot incontra una cartella di lavoro che contiene
collegamenti a celle di altre cartelle di lavoro, il sistema rimuove
il messaggio a comparsa di Excel in modo che il bot possa essere
eseguito senza interruzioni.

8840 00746651,
00757879

Dopo la migrazione dei bot, è possibile eseguire correttamente i
bot senza errori di pre-elaborazione. In precedenza, l'utilizzo di
variabili tra parentesi non consentiva l'elaborazione dell'attività.

8840 00742159,
00743092

Le azioni Imposta cella ed Elimina cella di Excel avanzato
selezionano ora le celle corrette quando il nome della colonna
dell'indirizzo della cella contiene più di una lettera.

8840 00743636 Le azioni Imposta cella, Elimina cella e Vai alla cella di Excel
avanzato supportano ora tutti gli intervalli. In precedenza, le
azioni riscontravano errori con intervalli superiori a AB1:AB100.

8815 00750668 Un bot carico di lavoro non è più bloccato in una coda e il
dispositivo non visualizza lo stato Scelto in fase di
esecuzione.

8815 00733227 Le tabelle di database Control Room vengono create quando
si utilizza il database 11.x ripristinato durante l'installazione di
Enterprise A2019.

© 2023 Automation Anywhere. All rights reserved.     429



    Automation Anywhere - Learn

Correzioni

Crea ID caso Service
Cloud

Descrizione

8815 00733720 Bot Migration Wizard non riscontra più errori durante
l'elaborazione di un bot di grandi dimensioni per la migrazione.
In precedenza, questo problema si verificava quando un bot di
grandi dimensioni veniva scaricato sul dispositivo Bot Runner per
la migrazione da Control Room e la connessione tra il dispositivo
Bot Runner e Control Room veniva ripristinata.

8815 -- Bot Scanner è stato ora aggiornato per includere gli scenari
che in precedenza non funzionavano dopo la migrazione. Di
conseguenza, alcuni bots potrebbero essere stati spostati
dall'elenco di bots che possono essere migrati all'elenco dei bots
che non possono essere migrati nel report di output. Ciò può
ridurre il numero di bots che possono essere migrati a Enterprise
A2019.

8815 00703679,
00711398,
00729399

I bots Enterprise 11 o Enterprise 10 che utilizzano la variabile
stringa o un oggetto acquisito da Internet Explorer la cui
proprietà è nulla o vuota, non riscontra più un errore dopo la
migrazione dei bots.

8815 00667326 Bot Scanner non si blocca più quando si esegue la scansione dei
bots per uno dei seguenti motivi:
• Scansione di un file .atmx danneggiato di un bot
• Bots che contengono il comando If, IF/ELSE o Loop e tale

comando viene commentato
• Bot che contiene un oggetto acquisito utilizzando il

comando Object Cloning comando utilizzando la modalità di
riproduzione Coordinata e sul quale viene eseguita l'azione
Fai clic

8815 00731068,
00737025

Non si verifica più un errore quando si esegue un bot che
contiene più variabili che restituiscono un valore numerico nello
stesso comando dopo che il bot è stato migrato.

8815 00720261 Non si verifica più un errore quando esegui la migrazione di un
bot con un nome di credenziale che contiene un carattere di
spazio o un carattere speciale.

8815 00713303 In un bot migrato che utilizza il comando Run Task, quando si
esegue una sottoattività all'interno dell'attività principale e il
nome della sottoattività contiene caratteri Unicode, il bot viene
ora eseguito correttamente senza errori. In precedenza, il bot
non funzionava per un errore.

8815 00691133 Ora puoi eliminare bots migrati nella tua area di lavoro privata
senza alcun problema. In precedenza, veniva visualizzato un
messaggio di errore quando un bot migrato veniva eliminato
nell'area di lavoro privata.

8815 00736166 In precedenza, quando veniva avviato il processo di migrazione,
questo a volte rimaneva nello In corso nel Bot Migration
Wizard. Ora il processo viene avviato.
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8815 00730131 I Bots che utilizzano il comando Run Script con la variabile
di sistema $Clipboard$ come variabile di input o output non
presentano più errori quando vengono eseguiti tali bots dopo la
migrazione a Enterprise A2019.

8815 00726833 Work Items Enterprise 11 e code associate a bots che utilizzano il
comando Variable Operation non presentano più un errore dopo
che il primo elemento nella coda è stato elaborato correttamente
successivamente alla migrazione a Enterprise A2019.

8815 -- Bot Scanner non presenta più un errore mentre si sta effettuando
la scansione di MetaBots contenenti il comando Object Cloning
commentato e il MetaBot sta tentando di rilevare la modalità di
riproduzione da questi comandi commentati.

8815 00716557 Non viene più rilevato un errore quando si esegue in Enterprise
A2019 un MetaBot creato in Enterprise 10, migrato a Enterprise
11 e quindi migrato a Enterprise A2019.

8815 00710569 Durante la migrazione di un MetaBot che contiene schermate
come risorse da Enterprise 11 a Enterprise A2019, i caratteri
giapponesi nelle proprietà dell'oggetto vengono ora visualizzati
correttamente nei bots migrati. In precedenza, i caratteri
giapponesi nelle proprietà dell'oggetto erano confusi nei bots
migrati.

8815 00702262 La pagina Cronologia attività ora mostra un messaggio di
errore dettagliato che specifica la causa dell'errore e la riga in
cui si trova per i bots migrati da Enterprise 11 e che utilizzano il
comando Error Handling.

8815 00703513,
00708988

I bots padre che utilizzano l'action Esegui del package Task
Bot con l'opzione In caso di errore, avvia la ripetizione
successiva selezionata non riscontrano più un errore se i
bots figlio riscontrano un errore durante l'esecuzione e non
restituiscono la variabile di output al bot padre. In precedenza,
i bots padre riscontravano un errore se i bots figlio non
restituivano la variabile di output ai bots padre perché i bots figlio
avevano riscontrato un errore durante l'esecuzione.

8815 00702601 Un bot che utilizza una variabile matrice che contiene una
variabile di sistema e che restituisce un numero intero non rileva
più un errore dopo la migrazione di tale bot.

8815 00707801 È ora possibile migrare un bot Enterprise 11 che contiene
il Mouse Fai clic per acquisire le coordinate di una finestra
ingrandita. Previously, the bot with a Mouse Click encountered
an issue during migration because the window left and top
parameters were set to negative values for maximized windows.

8815 00710315,
00728228,
00729082,
00744242

I bots migrati che utilizzano il comando Object Cloning con
tecnologia legacy per catturare oggetti con più righe di testo ora
funzionano correttamente, senza problemi.
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8815 00716650 Quando si esegue la migrazione di un bot Enterprise 11 che
contiene un comando Excel contenente due sessioni Excel, le
actions Ottieni nome colonna o Ottieni numero riga ora
visualizzano i valori corretti nell'output. In precedenza, le actions
impostavano valori di sessione errati nel bot migrato, se questo
conteneva due sessioni Excel.

8815 00711148 L'installazione di Enterprise A2019 non fallisce più se il
percorso dei dati e di log contiene uno spazio (ad esempio D:
\Automation Anywhere\ProgramData). Inoltre, non viene
più visualizzato il seguente messaggio di errore: Impossibile
creare le tabelle del database della Control
Room.

8815 00708902 Ora puoi utilizzare il package Google Drive per caricare i file
nell'unità condivisa di Google. Utilizza solo l'opzione ID cartella
per caricare i file in una cartella condivisa nell'unità e immettere
l'ID della cartella condivisa. In precedenza, si verificava un errore
quando l'utente tentava di caricare un file nella cartella condivisa
in Google Drive.

8815 00735479 Quando si crea un bot che ha una dipendenza con un lungo
percorso di archiviazione superiore al limite massimo di 256
caratteri e quando si esegue il bot sul computer Bot Runner, il
bot viene ora visualizzato un messaggio che richiede di ridurre la
lunghezza del percorso del file. In precedenza, l'esecuzione del
bot non andava a buon fine senza che alcun messaggio indicasse
il motivo dell'errore.

8815 00727406 Ora è possibile inviare un'e-mail in formato HTML con un allegato
HTML utilizzando il Server e-mail. In precedenza, quando
un'e-mail veniva inviata in formato HTML insieme a un file
HTML allegato, il corpo dell'e-mail e il contenuto del file allegato
venivano uniti. Di conseguenza, solo l'allegato veniva visualizzato
nella e-mail senza il contenuto del corpo.

8815 00707734 Nel package App Integration, quando si utilizza l'action
Acquisisci il testo della finestra in un browser giapponese,
il titolo della finestra viene ora visualizzato correttamente
per la lingua giapponese. In precedenza, l'output non veniva
visualizzato correttamente nel formato di testo giapponese.

8815 00699149,00707670È ora possibile utilizzare l'action Decomprimi del package
Folder ed eseguire i bots su un server Windows 10. Ora, se due
utenti Windows con credenziali diverse del dispositivo tentano
di distribuire un bot sullo stesso computer, la distribuzione non
fallisce. In precedenza, se un utente distribuiva il bot sullo stesso
computer con un profilo utente diverso, l'esecuzione del bot non
riusciva.
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8815 00695224,
00730472,
00739431

Quando si utilizza l'action Trova l'immagine nella finestra nel
package Image Recognition, i file immagine vengono eliminati
dalla posizione Temp e lo spazio di archiviazione viene liberato
dopo l'esecuzione del bot. In precedenza, i file di immagine non
venivano eliminati dalla posizione Temp e, di conseguenza, lo
spazio di archiviazione su disco si esauriva.

8815 00709162 L'action CSV/TXT Apri funziona ora senza riscontrare alcun
problema, anche se sono presenti valori vuoti nell'ultima riga
del file .txt. In precedenza, se nell'ultima riga del file erano
presenti valori vuoti, il bot riscontrava un problema.

8815 00711124 Nel package Email, quando utilizzi l'action Connetti, aggiungi
un loop e seleziona Per ogni mail nella casella di posta per
leggere le e-mail come opzione Iteratore, una nuova riga non
verrà più eliminata e sarà possibile visualizzare correttamente il
contenuto delle e-mail. In precedenza, le nuove righe venivano
eliminate quando il messaggio veniva inviato e ricevuto in
formato testo normale.

8815 00673049 Nel package SAP, se si verifica un errore quando si utilizza
l'action Connetti per connettersi a un sistema SAP, l'errore viene
ora acquisito nei blocchi Prova e Cattura. In precedenza, il
problema di connessione non veniva rilevato nei blocchi Prova e
Cattura dell'action.

8815 00697215 Un bot viene ora eseguito correttamente quando si utilizza
l'action Lancia con un'espressione. In precedenza, quando
un'espressione come $number.ToString$ veniva utilizzata
nel campo Messaggio di eccezione dell'action Lancia, il bot
riscontrava un errore di pre-elaborazione.

8815 00714260 Gli errori di runtime non vengono più visualizzati quando si
utilizzano:
• MetaBot che eseguono una funzione di migrazione DLL che

richiede più di un tipo di parametro come Array (matrice) o
qualsiasi tipo diverso da Stringa

• TaskBot che eseguono una logica che richiama un bot figlio
che assume più di un parametro di input di tipo Matrice,
mappato a una variabile Elenco nella funzione di migrazione
logica di esecuzione del bot padre

8815 00704547 L'action Pausa del package TaskBot ora funziona correttamente
quando viene utilizzata come ultima attività nel bot. In
precedenza, il bot non aspettava il completamento dell'attività se
l'action Pausa era stata utilizzata come ultima attività nel bot.

8815 00675344 Un TaskBot ora funziona meglio se si utilizzano le actions
Terminal Emulator Invia testo e Invia chiave per eseguire
un bot. In precedenza, il TaskBot impiegava molto tempo per
completare l'esecuzione.
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8815 00699650,00716648Quando si utilizzano le actions Image Recognition per eseguire
un bot e il bot non funziona durante l'esecuzione, le immagini di
origine e di destinazione acquisite vengono memorizzate in C:
\ProgramData\AutomationAnywhere\BotRunner\Logs
\IR con un massimo di 10 coppie di immagini di origine e di
destinazione. Ora, quando si raggiunge il massimo, le coppie di
immagini più vecchie vengono sovrascritte con nuove immagini.
In precedenza, i registri delle immagini non venivano sovrascritti.

8815 00716817 Un bot viene ora eseguito correttamente quando si utilizza
l'action PDF Estrai testo per estrarre il testo strutturato dai file
PDF. In precedenza, l'esecuzione del bot non riusciva a estrarre il
testo strutturato se questo conteneva caratteri tailandesi.

8815 00717204 È ora possibile utilizzare una credenziale da Credential Vault nel
campo URI delle actions REST Web Service.

8815 00682726,
00678580,
00695359,
00684985

Ora è possibile utilizzare Universal Recorder per automatizzare
le applicazioni Oracle Fusion Middleware. In precedenza, un
problema con l'API Java faceva in modo che il registratore
selezionasse l'intera finestra invece dell'oggetto specifico.

8815 00693770 Risolto un problema a causa del quale i numeri estratti
da un database SQL in una variabile tabella dati venivano
automaticamente convertiti in notazione scientifica.

8815 00669959 You can now select the same start date and end date when you
schedule bots with the Run repeatedly option (Activity >
Scheduled > Schedule bot) in the Control Room.

8815 00702841,
00700915

Disconnected devices are now displayed in the Control Room
(Devices > My Devices) when you filter the devices list by
Status as Disconnected.

8815 00707318,
00711529

Gli elementi di lavoro in una coda attiva vengono ora elaborati
e non è più necessario eliminare la coda attiva e creare un'altra
coda dopo l'aggiornamento da una versione precedente a questa
versione.

8815 00705046 I Bots che includono file dipendenti incorporati invece di una
cartella compressa non vengono più messi in coda in modo
intermittente per la distribuzione su dispositivi Bot Runner.

8815 -- Gli ID tenant disattivati o i tenant rimossi che vengono
successivamente riutilizzati nella stessa distribuzione con un
tenant diverso potrebbero generare un errore di licenza. Questo
conflitto è stato ora rimosso e i tenant rimossi in un successivo
riutilizzo non generano più l'errore.

8815 00685926 Quando si importa un bot esportato nell'area di lavoro privata
e si esegue l'archiviazione del bot, il bot importato viene ora
sottoposto ad archiviazione correttamente, senza problemi. In
precedenza, l'archiviazione non andava a buon fine a causa di un
errore di convalida dei metadati.
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Correzioni

Crea ID caso Service
Cloud

Descrizione

8815 00682025 Quando un bot o un file viene modificato nell'area di lavoro
pubblica, il file dipendente clonato nell'area di lavoro privata
riflette ora le modifiche e l'esecuzione del bot avviene
correttamente. In precedenza, il file dipendente clonato non
rifletteva le modifiche e l'esecuzione del bot non andava a buon
fine.

8815 00726018 L'action di Google Drive Carica file carica ora i file nelle
sottocartelle.

8815 00715080,
00731152

È ora possibile eseguire la distribuzione di bot non assistiti
concorrenti su un dispositivo multiutente con più sessioni utente
in esecuzione contemporaneamente.

8815 -- Un utente Bot Agent non amministratore rimane ora connesso a
Control Room senza essere frequentemente disconnesso.

8815 00709737 Le Actions nel package Google Sheets supportano ora fogli di
lavoro contenenti celle vuote.

8815 00710354 Non viene più visualizzato un errore di eccezione di ibernazione
quando si accede a Control Room come utente Admin
(amministratore).

8815 00732178 È ora possibile eseguire l'estrazione dei bots da cartelle con nomi
simili ma in lettere maiuscole e minuscole diverse e modificare i
bots nell'area di lavoro privata in Control Room.
Ad esempio, se nell'area di lavoro pubblica sono presenti una
cartella denominata Automation1 e nell'Automation1 e
nell'area di lavoro privata una cartella denominata automation1,
è possibile eseguire l'Automation1, è possibile eseguire
l'estrazione dei bots dalla cartella Automation1 nell'area di
lavoro pubblica.

8815 -- I Bots vengono ora distribuiti su un dispositivo multiutente in
una sessione utente non amministratore quando sul dispositivo è
attiva anche un'altra sessione utente amministratore se l'accesso
automatico a Control Room è impostato in modo da bloccare
la sessione al termine dell'esecuzione del bot in una sessione
sbloccata esistente.

8815 00719407 Durante l'installazione cluster di Enterprise A2019 su Red Hat
Enterprise Linux, il programma di installazione utilizza ora lo
stesso ID utente per tutti i nodi del cluster.

8815 00703325 L'autorizzazione del file di registro per una Control Room
installata su Linux viene ora mappata all'utente crkernel. In
precedenza, veniva mappata all'utente radice.

8815 -- Quando si accede a Control Room con l'opzione Accedi con
Windows selezionata, è ora necessario immettere il FQDN per
effettuare l'accesso.
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Correzioni

Crea ID caso Service
Cloud

Descrizione

8815 00732141,
00722919,00743006

Quando si precarica un package, una volta completato il
download, lo stato di completamento viene aggiornato nella
pagina Attività > Cronologia attività e il record in sospeso
non viene più visualizzato nella pagina Attività > In corso.

8815 00731376 Quando si esegue la migrazione della logica MetaBot, se il nome
della variabile e la variabile di mappatura non corrispondono,
le variabili non vengono più create due volte. Di conseguenza,
quando si esegue l'operazione non viene più visualizzato un
errore di pre-elaborazione.

8815 Ora, la migrazione della logica di esecuzione con variabili CV è
supportata.

8815 Ora, quando si utilizza la variabile di sistema Data nel comando
cartelle File, il bot migrato non riscontra più errori.

8815 Quando si esegue la migrazione di bots (da v11.x ad A2019) con
proprietà OC superiori a 64 KB, tali proprietà verranno troncate e
il bot verrà migrato.

Limitazioni

(ID caso Service Cloud: 00822176) When you create an RDP session on multi-user devices and
enter a custom port, RDP-based deployments will fail.
Azione consigliata: Use the default port 3389 for RDP sessions.

Quando si crea un bot con le actions del browser Apri e Chiudi in un ciclo e si seleziona l'opzione
Finestra per chiudere la scheda selezionata, potrebbe verificarsi un errore durante l'esecuzione del
bot.
Soluzione: Utilizzare una action Chiudi del package Window invece di una action Chiudi nel
package Browser per chiudere la finestra.

Se la distribuzione dei bots avviene utilizzando trigger di evento e si installa Bot Agent su un
dispositivo come utente non amministratore per sé o un utente amministratore locale, Bot Agent
non verrà aggiornato automaticamente. Il dispositivo verrà visualizzato come disconnesso in Control
Room.
Soluzione:
1. Terminare il processo listener di trigger Java (javaw.exe) da Gestione attività.
2. Reinstallare Bot Agent per ricollegare il dispositivo utente a Control Room.

La configurazione di più indirizzi IP per i nodi Control Room in un cluster non è supportata durante
l'installazione nelle distribuzioni On-Premises. È necessario configurare manualmente l'indirizzo IP
primario nel file cluster.properties.
Aggiungere l'indirizzo IP primario per il cluster alla pagina 972 | Configurare l'indirizzo IP aggiuntivo
per un nuovo nodo del cluster alla pagina 973

La distribuzione di Bot su sessioni multiutente non è supportata per l'automazione dei carichi di
lavoro.
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Limitazioni

L'utilizzo di una sala di controllo Enterprise A2019.20 SDS On-Premises insieme a una sala di
controllo Enterprise A2019.19 Cloud Control Room non è supportato.

Quando si esegue un bot che contiene un'action Acquisisci che utilizza la funzione oggetto di
ancoraggio, le impostazioni DPI del dispositivo devono corrispondere alle impostazioni in base alle
quali è stato configurato l'oggetto di ancoraggio.

La Control Room non consente l'uso di trattini e trattini bassi in modo intercambiabile durante la
creazione e la chiamata di nomi di valore globali.

Quando si esegue la migrazione di un bot Enterprise 11 che utilizza il comando Object Cloning con
tecnologia Silverlight e si esegue il suddetto bot in Enterprise A2019, l'esecuzione del bot potrebbe
non riuscire a causa di un errore dovuto a un problema di affidabilità della riproduzione. La stessa
affidabilità di riproduzione si osserva anche in Enterprise 11 quando si utilizza il comando Object
Cloning con i plug-in Silverlight.

Per le actions che utilizzano l'input da file, quando si seleziona un percorso di rete utilizzando
Sfoglia, l'esecuzione del bot non riesce perché la barra rovesciata doppia (\\) nella posizione del
file viene sostituita da una barra.
Soluzione: Non utilizzare l'opzione Sfoglia per selezionare la posizione del file. Immettere invece
manualmente il percorso completo del file.

Quando un utente Bot Creator, Bot Runner assistito o Bot Runner non assistito accede alla Control
Room dal proprio computer Bot Agent e l'opzione di download del pacchetto è abilitata, il download
del pacchetto ha la priorità e la distribuzione del bot resterà in attesa fino al completamento del
download del pacchetto. Ciò si verifica solo quando il pacchetto viene scaricato per la prima volta.

Quando un bot esegue un'automazione nel browser Microsoft Internet Explorer, l'API Microsoft
responsabile del ritardo del browser potrebbe riscontrare un'eccezione, causando il mancato
funzionamento del bot e la visualizzazione di un messaggio di errore relativo a Chrome nella Control
Room.

(ID caso Service Cloud: 00712808) I file correlati a Automation Anywhere vengono talvolta generati
in C:\Windows\Temp. Questi file possono essere eliminati in modo sicuro.

Per i bots Enterprise 11 che contengono un oggetto acquisito utilizzando il comando Object
Cloning in modalità di riproduzione Immagine o Coordinata, Imposta testo viene eseguita
su quell'oggetto e la variabile delle credenziali viene utilizzata per impostare il testo dell'oggetto.
La variabile delle credenziali di questi bots non viene migrata quando i bots migrano a Enterprise
A2019.

If you use the Set text action in the Recorder > Capture action to enter data into a text box,
when you run the bot, the data appears over the old data in the text box and is not entered. The
old data is not cleared from the text box because the application requires a physical event to clear
the old data.
Soluzione: To ensure that the data is entered into the text box, along with the Set text action,
add a value greater than 0 in the Time between keystrokes field.

When you use the Recorder to capture an object, set the waiting time for detecting the object to
less than 30 seconds in the Keep trying for (seconds) field, and run the bot, the Recorder waits
for a minimum of 30 seconds by default to detect the object.
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Limitazioni

When you use the Recorder to capture objects on an application that is installed on a virtual
machine, finish the recording after the objects are captured, and relaunch the Recorder, the bot
inserts the actions recorded earlier instead of launching the Recorder.
Soluzione: Refresh the Bot editor or run the bot to launch a new session to start recording again.

Automation Anywhere Robotic Interface (AARI)

Novità

Ottenere file di archiviazione
La nuova azione Acquisisci file di archiviazione nel pacchetto Web AARI  consente di scaricare
i file di archiviazione su un dispositivo bot.
AARI Web package alla pagina 1369

Caricare i file nei moduli o nelle attività iniziali
Aggiungi l'elemento Seleziona file ai moduli per consentire agli utenti di selezionare e caricare i
file nei moduli o nelle attività iniziali nell'interfaccia Web. Gli utenti possono navigare per caricare
un nuovo file o sostituire un file esistente. Il file caricato viene visualizzato come collegamento
ipertestuale e, quando viene aperto, reindirizza gli utenti a una nuova scheda.
Configura i processi alla pagina 2121

I collegamenti ipertestuali supportano i moduli o le attività iniziali
Usa il nuovo elemento di Collegamento ipertestuale per aggiungere collegamenti ai moduli e
accedervi nei moduli e nelle attività iniziali.
Configura i processi alla pagina 2121

Configurare un utente Pianificatore per ciascun processo (ID caso Service Cloud:
00713786)
In qualità di amministratore AARI, puoi ora configurare un utente pianificatore per ciascun processo
per allocare le risorse Control Room (dispositivi e Bot Runners non assistiti) sull'interfaccia Web. Per
impostazione predefinita, è selezionato l'utente Pianificatore globale se per i singoli processi non
è configurato alcun utente pianificatore.
Configure scheduler user for AARI on the web alla pagina 2118

Aggiornamento del pannello delle proprietà per l'attività umana (ID caso Service Cloud:
00718109)
Come Bot Creator, puoi scegliere di non configurare alcuna azione nell'attività umana selezionando
la casella di controllo Rendi il modulo di sola lettura nel pannello Proprietà. L'attività umana
non richiede alcun input e viene eseguita automaticamente nell'attività successiva.

Aggiungere un segnalibro a qualsiasi pagina come pagina di destinazione per AARI sul
Web
L'interfaccia Web è stata migliorata con un nuovo sistema a più pagine, in modo da poter
aggiungere direttamente dei segnalibri a qualsiasi pagina (Richieste, Attività o Cestino) come
pagina di destinazione. Inoltre, le schede nell'interfaccia Web sono state rimosse in modo che le
richieste vengano aperte una alla volta e non simultaneamente. Per eseguire più attività, è possibile
aprire le pagine delle richieste in diverse schede del browser.
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Novità

Miglioramento della navigazione in AARI sul Web
L'interfaccia Web è stata migliorata con un riquadro di navigazione laterale, in modo da poter
accedere facilmente a varie pagine (Processi, Richieste, Cestino e Attività).

Nuova pagina Processi (ID caso Service Cloud: 00694786)
Come utente AARI, accedi ai processi assegnati e crea nuove richieste utilizzando la nuova pagina
Processi nell'interfaccia Web. Utilizza la barra di navigazione per accedere rapidamente alla pagina.

Miglioramento dell'elemento Pulsante
• Puoi ora utilizzare l'opzione Non consentire il clic sul pulsante quando questo modulo

viene caricato per la prima volta per disabilitare l'elemento Pulsante in un modulo quando
questo viene visualizzato per la prima volta durante il runtime del bot.

• Utilizza l'opzione Sottotitolo nel menu a discesa Tipo di pulsante se si desidera che
l'elemento pulsante venga visualizzato come collegamento durante il runtime del bot.

Utilizzo dell'elemento Pulsante alla pagina 2190

Miglioramenti al logo del modulo
È ora possibile utilizzare l'opzione campo Logo nel piè di pagina per selezionare fino a due logo
indipendenti che vengono visualizzati nel piè di pagina del modulo durante il runtime del bot.
Create a form alla pagina 2186

Cosa è cambiato

Miglioramento del processo di eliminazione
Un amministratore AARI o un utente con autorizzazione Elimina da pubblica può ora eliminare
un processo dall'area di lavoro pubblica. Quando il processo viene eliminato dall'area di lavoro
pubblica, viene rimosso dalla pagina di gestione dei processi nell'interfaccia Web. Inoltre, se il
processo era già assegnato a un utente o a un team AARI, dopo l'eliminazione del processo, viene
rimosso l'accesso.
Eliminare un processo AARI alla pagina 2148

Aggiornamento della finestra del selettore variabile
Il selettore variabile è ora organizzato nelle sezioni Origine variabile Tipo di variabile e
Variabile. L'origine variabile contiene una richiesta o un'attività. Il tipo di variabile è ora un'opzione
di interfaccia che consente di selezionare i itipi nput, output o metadati. L'opzione variabile specifica
i nomi e il tipo di variabile.

Richiesta dell'origine variabile
Il selettore variabile consente ora agli utenti di selezionare un'origine variabile Richiesta con tipi di
variabile Input (precedentemente Dati iniziali) e Meta.
Crea un processo AARI alla pagina 2133 | AARI variable types alla pagina 2141

Inserimento di variabili nel testo esistente
È possibile utilizzare il selettore di variabili nell'editor di processo per inserire o aggiungere variabili
senza sostituire i testi esistenti.
Crea un processo AARI alla pagina 2133
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Cosa è cambiato

Aggiornamento del filtro
Nell'interfaccia Web, quando filtri o cerchi parole chiave, l'interfaccia utente del filtro aggiorna ora e
riflette i criteri di filtro di conseguenza. Ad esempio, se si cerca lo stato finale delle richieste, il filtro
mostra Stato:In sospeso.

Correzioni

ID caso Service Cloud Descrizione

00702607 Se è presente un'action Finestra di messaggio
all'interno di un ciclo di trigger, è ora possibile
utilizzare l'opzione Esegui da qui per eseguire il bot
senza messaggi di errore.

00725237 I messaggi di errore non vengono più visualizzati
quando l'elemento Elenco a discesa nel modulo
viene popolato con valori dinamici durante il runtime
del bot.

00733978 I moduli con elementi di sola lettura possono ora
essere inviati correttamente senza problemi quando il
valore del campo del modulo è superiore a 100.

- Se si seleziona una delle opzioni Comportamento
avanzato nell'elemento Elemento a discesa,
i messaggi di errore non vengono più visualizzati
durante il runtime del bot.

-- A Bot Task can now pass data to the next task
(Human Task or Bot Task) if it contains Japanese
characters in its output variable name. È necessario
utilizzare caratteri inglesi per il nome della variabile in
Attività bot.

-- In ambiente cloud, l'interfaccia Web AARI visualizza
ora la schermata corretta per le impostazioni locali
selezionate. In precedenza, la schermata non veniva
visualizzata correttamente per le impostazioni locali
selezionate.

Limitazioni

Nell'editor di processo, la condizione Se/Altrimenti del tipo stringa non consente di lasciare vuoti
i valori di origine e destinazione. Di conseguenza, non è possibile convalidare se una variabile di
stringa è vuota.
Soluzione: Creare una variabile stringa di output vuota per il bot. Utilizzare questa variabile come
valore di destinazione per eseguire un confronto con una variabile di origine modulo o bot in modo
che la convalida nella condizione Se/Altrimenti non abbia esito negativo.
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Limitazioni

Quando si immettono dati in un modulo del processo che contiene un collegamento ipertestuale,
i dati vengono ignorati quando si tenta di inviare il modulo. Il collegamento ipertestuale visualizza
invece i seguenti comportamenti:
• Quando l'URL del collegamento ipertestuale è configurato in un momento specifico (il processo

di progettazione dell'interfaccia o di impostazione delle proprietà), l'URL rimane invariato dal
processo.

• Quando l'URL del collegamento ipertestuale non è configurato in un momento, specifico l'URL
viene impostato sul dominio Control Room.

Discovery Bot

Novità

Cercare un processo aziendale dalla pagina Processi
È ora possibile utilizzare il campo di ricerca per individuare un processo specifico per nome. Questo
campo non è sensibile alla distinzione tra maiuscole/minuscole. Il campo di ricerca è disponibile
nella pagina Processi.
Create a Discovery Bot process alla pagina 2344

Visualizzare tutte le immagini acquisite dalla finestra modale dello screenshot
È ora possibile navigare tra tutte le schermate acquisite facendo clic su un'immagine a dimensione
completa dalla finestra modale. Fai clic sull'impaginazione situata sotto l'immagine per selezionare
un numero di fase o utilizza le frecce destra o sinistra per visualizzare rapidamente tutte le immagini
acquisite.
Registrare un processo aziendale Discovery Bot alla pagina 2348

Il pacchetto Process Discovery è incluso nei pacchetti predefiniti
Il pacchetto Process Discovery è ora incluso nei pacchetti predefiniti. È possibile precaricare il
pacchetto predefinito quando si effettua la connessione al dispositivo. Precaricare il pacchetto aiuta
a ridurre l'ora di avvio del registratore la prima volta che si inizia la registrazione di un processo
Prerequisiti per Discovery Bot alla pagina 2335

Miglioramenti del registratore
Puoi ora eseguire azioni come fare doppio clic, trascinare e rilasciare e selezionare il testo
durante la registrazione di un processo aziendale. Le azioni eseguite con i tasti di scelta rapida
vengono visualizzate nel campo Dati. Il doppio clic viene acquisito dal registratore e visualizzato
nell'immagine della pagina Registrazioni.

Nota:  Il registratore Discovery Bot non acquisisce le azioni di trascinamento e mantenimento del
clic dalla pagina Registrazioni. Per includere queste azioni eseguite durante la registrazione, puoi
documentare le singole fasi nel campo Descrizione fase per l'analista.

Registrare un processo aziendale Discovery Bot alla pagina 2348

Supporto per indirizzi IPv6
Gli indirizzi IPv6 sono ora supportati per Discovery Bot.
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Novità

Supporto Linux
Discovery Bot è ora supportato sulle piatteforme Red Hat Enterprise Linux e Linux CentOS.
Installing Control Room on Linux alla pagina 948

Supporto per la disponibilità elevata
Discovery Bot supporta ora la distribuzione a disponibilità elevata.
High availability deployment alla pagina 891

Cosa è cambiato

Modifica del percorso dell'archivio predefinito per l'installazione personalizzata
Per l'installazione personalizzata, è ora possibile modificare la posizione predefinita del percorso
dell'archivio in una nuova posizione sul server dopo l'installazione.
Prerequisiti per Discovery Bot alla pagina 2335

Correzioni

ID caso Service Cloud Descrizione

-- È ora possibile esportare un PDD per
un'opportunità con 2000 passaggi utilizzando
l'opzione Scarica PDD dalla pagina
Opportunità.

Limitazioni

Quando si utilizza il tasto Tab per passare da un campo all'altro in un campo di tipo password, i
dati immessi vengono visualizzati come testo in chiaro, ad esempio quando si passa dal campo
Nome utente a Password. Consulta il testo nel campo Dati per informazioni riservate prima di
trasmettere il processo.

Alcune azioni potrebbero non essere supportate durante una sessione di registrazione, ad esempio
quando si fa clic sulla scheda Rete in modalità Ispeziona utilizzando Chrome. Per tali azioni non
supportate, metti in pausa il registratore, completa l'azione e riprendi la registrazione.

Quando si registra un processo con più di 1000 passaggi, il caricamento della pagina Registrazioni
richiede un po' di tempo.
Soluzione: A seconda dell'ambiente in cui ti trovi, puoi eseguire una delle seguenti azioni:
• Suddividere la registrazione in più sessioni di registrazione. Ad esempio, è possibile suddividere i

1000 passaggi in 10 registrazioni separate.
• Attendere che tutti i passaggi vengano caricati sulla pagina prima di inviare il processo per la

revisione.

© 2023 Automation Anywhere. All rights reserved.     442



    Automation Anywhere - Learn

IQ Bot

Novità

Miglioramenti al IQ Bot Classifier package
L'action Esegui formazione del classificatore offre ora un'opzione per formare nuovamente i
documenti utilizzando un file di modello esistente.
Using Train Classifier action alla pagina 1644

Cosa è cambiato

Ridenominazione delle IQ Bot Pre-processor actions
I nomi di tutte le actions disponibili nel package IQ Bot Pre-processor sono stati modificati. Ad
esempio, Ottieni codici a barre action è stato rinominato come Ottieni codici a barre.
IQ Bot Pre-processor package alla pagina 1647

Download di tutti i documenti elaborati senza timeout (ID caso Service Cloud: 00587817)
Ora puoi scaricare tutti i file elaborati dal server Amazon S3 sul tuo computer locale senza causare
timeout, indipendentemente dal numero di file. Anche se scegli l'opzione Elimina i file dal server
dopo il download e se il download non riesce, è possibile scaricare nuovamente un file compresso
.zip contenente i documenti non andati a buon fine.
Azione Download all documents (Scarica tutti i documenti) alla pagina 1662

Miglioramenti alle API IQ Bot (Service Cloud Case ID: 00688683, 00688678, 00688675)
• File upload API (API caricamento file) restituisce ora l'ID del file caricato.
• File status API (API stato dei file) accetta ora un ID file e restituisce il suo stato come

codice di stato.
• File dowload API (API download file) restituisce ora i dati estratti in formato JSON per un

file caricato correttamente.

APIs to upload files, check file status, and downloading CSV file (A-People login required)

Licenza IQ Bot rinominata
La licenza richiesta per l'esecuzione di IQ Bot è ora rinominata Piattaforma IQBot dalla
precedente Piattaforma cognitiva.
Licenses overview

Correzioni

ID caso Service Cloud Descrizione

00708806 Ora puoi salvare documenti fino a 20 MB dopo la
convalida, senza problemi.

00662968 Risolto un problema che causava la mancata
risposta del servizio gateway.
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Correzioni

ID caso Service Cloud Descrizione

00644948 Quando si carica un documento in produzione,
non si verificano più blocchi nel sistema e i
documenti vengono inviati correttamente al
Validator.

00707965 Quando si esegue la migrazione da IQ Bot
Enterprise 11 a A2019 utilizzando lo strumento
Migration Assistant, tutte le tabelle di database
vengono migrate correttamente, senza errori.

00715124 IQ Bot ora elimina i file temporanei scaricati dal
server Amazon S3 nella cartella C:\windows
\temp quando non sono più necessari. Di
conseguenza, l'archiviazione non viene più
utilizzata da questi file temporanei.

-- Sono ora disponibili registri per i server dei
nodi IQ Bot nella cartella C:\Users\Public
\Documents\Automation Anywhere IQBot
 Platform\Logs\.

-- IQ Bot visualizza ora un messaggio di errore
quando aggiorni la pagina dei risultati
dell'estrazione per un'istanza di apprendimento,
quando il relativo bot associato viene spostato in
produzione.

-- Durante la creazione di una tabella nella
pagina Designer, facendo clic su Vedi risultati
estrazione senza completare la creazione della
tabella, viene ora visualizzato il messaggio di
errore corretto.
In precedenza, veniva visualizzato il seguente
messaggio errato: L'anteprima verrà
 aperta in una nuova scheda.

-- Quando elimini un bot e fai clic sull'opzione
Prova bot nella pagina di elenco Bots, viene
ora visualizzato il seguente messaggio di errore
corretto: Bot non trovato.

-- La logica Python è ora applicata correttamente
su tutte le tabelle. In precedenza, IQ Bot non
riusciva a eseguire la logica Python per le tabelle
diverse da quella predefinita.
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Correzioni

ID caso Service Cloud Descrizione

-- È possibile visualizzare registri più granulari per
la risoluzione dei problemi RabbitMQ v3.8.18.
Questi registri sono ora memorizzati nella
cartella C:\Users\Public\Documents
\Automation Anywhere IQBot Platform
\Logs\RabbitMQ, a seconda del livello di
registro, delle dimensioni del registro e del limite
di rotazione.
Se si verifica un errore nella connessione
RabbitMQ v3.8.18, questi registri di arresto
vengono memorizzati nella cartella C:\Users
\Public\Documents\Automation
 Anywhere IQBot Platform\Logs
\RabbitMQ\log.

-- Quando si crea un ruolo utente con caratteri non
inglesi a 2 byte, ora l'esecuzione dei servizi non
fallisce più.

-- If there is an existing database, IQ Bot installer
now does not check for the db_creator role
for that user.

-- A user with AAE_IQ Bot Validator role and
AAE_Basic role can now successfully launch
and validate documents in the IQ Bot Validator.

Limitazioni

Gli indirizzi IPv6 non sono supportati per IQ Bot, quindi assicurati di utilizzare solo gli indirizzi IPv4.

Se si tenta di applicare la logica Python a una colonna collegata tra due tabelle, viene visualizzato
un messaggio di errore per la colonna collegata nella seconda tabella e la logica applicata non
riesce.

Se si aggiunge una libreria bloccata a una logica Python personalizzata e si fa clic su Esegui test
per qualsiasi campo, viene visualizzato un messaggio di errore nella pagina di progettazione.
Soluzione: Rimuovere la libreria bloccata dalla logica Python.

Se si utilizza l'opzione Sovrascrivi per importare un'istanza di apprendimento, vengono importati
tutti i bots e i gruppi disponibili.

When you use the Process documents action from the IQ Bot Extraction package to run a bot
through workload management, the Current Action tab displays Downloading additional
resources along with your command instead of IQ Bot extraction in the In progress
activity page.

Il tempo medio di elaborazione aumenta quando si utilizza il package IQ Bot Extraction su un
documento con più di 30 pagine.
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Limitazioni

L'esecuzione di bots esistenti che utilizzano il package IQ Bot Pre-processor potrebbe non riuscire
dopo l'aggiornamento a questa versione.
Soluzione: Poiché i nomi delle actions disponibili nel package IQ Bot Pre-processor sono cambiati,
eliminare le actions esistenti nei bots e aggiornarle con i nuovi nomi prima di eseguire i bot.

(ID caso Service Cloud: 00601790) Non è possibile effettuare la registrazione di IQ Bot quando
Control Room è installato su un computer Linux.

When you run a bot that has the IQ Bot Extraction package, the activity information under In
progress > Current Action does not display the details correctly.

Se si utilizza l'opzione File Download API, la risposta json ricevuta non ha un formato valido.
Soluzione: Questo problema si verifica perché : (due punti) è sostituito da = (segno di uguale) nel
valore chiave json. Dopo aver ricevuto la risposta json, utilizza le seguenti opzioni:
• Sostituisci = con :
• Aggiungi " (virgolette doppie) in ciascun testo

When you try to sort the PagesUpload column in the Learning instance > Document Group
tab, an error message is displayed.

On the Designer, if you resize the system identified region (SIR) of an auto-mapped field, the values
from the resized selection are not captured in the corresponding value field.
Workaround:To update the content of an auto-mapped field:
1. Select the entire SIR region.
2. Draw a bigger bounding box around the region.

Bot Insight

Novità

Accesso con ruolo AAE_Admin all'API delle operazioni da connettore Power BI
Il connettore Power BI fornisce ora l'accesso con ruolo utente AAE_Admin all'API operativa
botrundata. Con questo ruolo, è possibile connettersi all'API botrundata ed estrarre metriche
operative da analizzare e visualizzare all'interno di Power BI.

Miglioramenti al dashboard di pubblicazione (produzione)
Gli utenti con ruolo Amministratore AAE_Bot Insight e Esperto AAE_Bot Insight possono
ora modificare il dashboard pubblicato. Puoi utilizzare l'opzione Salva per salvare il dashboard di
produzione come dashboard di produzione personalizzato e aggiungere widget al tuo dashboard
personalizzato. Puoi inoltre eliminare un dashboard di produzione predefinito e un dashboard di
produzione personalizzato.
Salvare un dashboard pubblicato alla pagina 2971 | Eliminare un dashboard pubblicato alla pagina 2972

Importante:  Le informazioni sui pacchetti supportati vengono spostate in questo argomento: View
package versions available in the Control Room alla pagina 2009.
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Note su Enterprise Edition A2019.19
Data di rilascio:11 febbraio 2021

Esamina le funzionalità nuove e modificate, i problemi risolti, le correzioni per la sicurezza, le funzionalità
obsolete e le limitazioni note in Enterprise A2019.19. Enterprise A2019.19 Build 8147 è disponibile per On-
Premises e Build 8145 è disponibile per Cloud. IQ Bot è nella Build 8098.

Importante:  Abbiamo aggiornato le build Enterprise A2019.19 per includere le correzioni per i seguenti
problemi:
• Variabili di sistema che vengono visualizzate vuote nel campo di azione (ID caso Service Cloud

00737695, 00737698)
• Modifica delle dimensioni della tabella quando si crea una nuova variabile tabella in On-Premises (ID

caso Service Cloud 00725978, 00727695, 00736105)
• Problemi durante la modifica di un bot in Bot editor e apertura della pagina di elenco packages che

include caratteri speciali (ID caso Service Cloud 00733529, 00739634)
• Assegnazione di un bot dall'area di lavoro privata a una variabile di file (ID caso Service Cloud

00727695)
• Actions Nel package Image Recognition che non consentono l'uso di file con estensione .PNG e file con

lettere maiuscole nell'estensione (ID caso Service Cloud 00734972, 00734266)
• Nomi delle variabili in maiuscolo che cambiano in minuscolo, trattino che diventa trattino basso e

variabile non visualizzata se contiene un carattere maiuscolo (ID caso Service Cloud 00734784,
00734842, 00734999)

• Bots non distribuiti su un dispositivo multiutente quando la sessione utente viene disconnessa e non
esiste alcuna sessione attiva (ID caso Service Cloud 00727228, 00722888, 00732830, 00732835,
00733877, 00733362, 00726489, 00733070, 732959, 733160, 733269, 733321, 733391, 733435,
733438, 733451, 733680, 733765, 733770, 733790, 733940, 00734067)

• bots figlio che riscontra un errore se contiene l'action Trova finestra nella finestra del package
Image Recognition (ID caso Service Cloud 00727031, 00730358, 00733607, 00733544, 0073464)

• Utilizzo di variabili con nomi scritti con notazione a cammello nei packages Data Table, List e Loop
(ID caso Service Cloud 00733263, 00733459, 00733007, 00733988, 00734168, 00733141, 00733074,
00733087, 00733001, 00734019)

Per ulteriori informazioni, vedi le sezioni Problemi risolti per Enterprise A2019 e AARI.

• Funzionalità di migrazione alla pagina 448
• Enterprise A2019 alla pagina 449
• AARI
• Discovery Bot alla pagina 465
• IQ Bot alla pagina 466
• Bot Insight alla pagina 469
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Funzionalità di migrazione

Enterprise 11 e Enterprise 10 funzionalità

Rivedi i messaggi in Migration Assistant
Migration Assistant visualizza i messaggi di revisione per i bots migrati. Apri Migration Assistant per
un bot per visualizzare e rivedere i messaggi per quel bot.
Visualizzazione delle modifiche ai bots migrati utilizzando Bot Assistant alla pagina 1301

Esegui la migrazione dei MetaBots con le schermate
Migrare MetaBots che contengono schermi come asset. Puoi migrare le schermate basate sulla
tecnologia di automazione dell'interfaccia utente e acquisirle utilizzando la modalità di riproduzione
Oggetto.
Come viene eseguita la migrazione di MetaBots alla pagina 1223

Rivedi i messaggi nel report del Bot Scanner
Il report del Bot Scanner mostra i messaggi di revisione relativi alla modifica del comportamento nei
comandi utilizzati in bots che possono essere migrati in Enterprise A2019.
Analisi del report di Bot Scanner per la migrazione alla pagina 1162

Interrompere, mettere in pausa e riprendere la migrazione
You can stop, or pause and then resume the migration process from the bot launcher and the
Activity > In progress page.
Interrompi la migrazione bot alla pagina 1245 | Sospendere e riprendere la migrazione dei bot alla pagina
1243

Migrazione di bots che utilizza l'azione di acquisizione testo scorrevole nel comando
App Integration
I comandi App IntegrationEnterprise 11 e Enterprise 10 che acquisiscono il testo da una finestra
di applicazione con una barra di scorrimento verticale vengono migrati in Integrazione app >
Acquisisci testo scorrevole action in Enterprise A2019.
Mappatura dei pacchetti per la migrazione alla pagina 1247

Funzionalità esclusive di Enterprise 11

Mappatura dell'output del comando PDF integration a più variabili
L'output di un bot Enterprise 11 che utilizza il comando PDF integration viene mappato con più
variabili nelle equivalenti actions del package PDF dopo che il bot è stato migrato a Enterprise
A2019.

Migrazione di bots che utilizzano i seguenti attributi:
• Bots che inviano testo giapponese al terminale VT100 utilizzando il comando Invia testo
• Bots che utilizzano il comando Ottieni nodo singolo o Ottieni nodi multipli per estrarre i

nodi che contengono gli spazi dei nomi da un file XML
• Bots che contengono il comando Connetti del comando Terminal Emulator e il valore nel campo

Attendi timeout che è inferiore a cento millisecondi
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Funzionalità esclusive di Enterprise 11

Migrazione di bot che utilizzano le seguenti opzioni nel comando Active Directory:
• Il comando Modifica oggetto con le azioni Rinomina, Elimina, Sposta e Imposta proprietà per

il tipo di oggetto Computer e Unità organizzativa.
• Il comando Modifica gruppo con le azioni Aggiungi utenti a un gruppo e Rimuovi utenti

da un gruppo.
Mappatura dei pacchetti per la migrazione alla pagina 1247

Funzionalità esclusive di Enterprise 10

Migrazione della versione più recente di bots Enterprise 10 abilitati al controllo delle
versioni
È ora possibile eseguire la migrazione della versione più recente di bots dalla Control Room
Enterprise 10 configurata con controllo della versione SVN a Enterprise A2019. Utilizza l'opzione
Copia dati 10.x per copiare la versione più recente di bots Enterprise 10 in Enterprise A2019 e
quindi utilizza Bot Migration Wizard per migrare i bots a Enterprise A2019.
Copia dati Enterprise 10 alla pagina 1207 | Come vengono copiati i dati di Enterprise 10 in Automation
360 alla pagina 1204

Enterprise A2019

Importante:  This release includes a required update to your . Ensure that you complete the update to
continue with your automation activities when upgrading from a previous release to this release.
Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina
1043

To verify which  version is compatible with this release, see Compatibility with release builds alla pagina
1026.

Nuove funzionalità

Impostazioni di accesso automatico
La configurazione di accesso automatico è disponibile in Control Room per ridurre il tempo di
avvio dei bot riutilizzando una sessione utente esistente. Configura l'accesso automatico nelle
impostazioni Amministratore per tutti i dispositivi o personalizzalo dalla pagina Dispositivi per
ciascun dispositivo.
• Configura le impostazioni di accesso automatico per una sessione utente per creare una nuova

sessione o riutilizzare una sessione esistente
• Mantieni le sessioni utente sbloccate
• Disconnessione da una sessione utente dopo che il bot ha completato l’esecuzione

Configure auto-login settings alla pagina 2732 | Dispositivi alla pagina 2628
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Nuove funzionalità

Nuovo utilizzo della CPU e impostazioni della memoria del dispositivo
Configura l'utilizzo della CPU e il valore di soglia della memoria del dispositivo nelle impostazioni
Control Room per determinare se distribuire o meno i bots sui dispositivi.
Configurare le impostazioni di soglia per i dispositivi utente alla pagina 2732

Installa Bot Agent sui dispositivi senza i privilegi di amministratore
È ora possibile scegliere di installare Bot Agent sui dispositivi utente con privilegi di utente locale
(senza i privilegi di amministratore) a livello di utente locale o privilegi di amministratore a livello di
sistema.
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039 | Crea pool di dispositivi alla
pagina 2636 | Utenti alla pagina 2683
Quando effettui l'installazione del Bot Agent a livello di utente, il dispositivo non sarà disponibile
come dispositivo predefinito per un altro utente e per la selezione del pool di dispositivi durante la
distribuzione del bot. Per ulteriori informazioni, vedi Bot Agent limitazioni note.

Nuova utilità diagnostica per Bot Agent
Utilizza l'utilità diagnostica Bot Agent per eseguire controlli diagnostici sui dispositivi Bot Runner e
per ricevere assistenza nella risoluzione dei problemi di connettività Bot Agent.
Esecuzione di controlli diagnostici Bot Agent alla pagina 1048

Nuove funzionalità nel Data Table package (ID caso Service Cloud: 00656843, 00707635)
• Utilizza l'action Modifica tipo di colonna nel package Data Table per eseguire operazioni sulla

colonna di una tabella di dati. Utilizza questa action per modificare il tipo di dati della colonna in
Booleano, Data e ora, Numero o Stringa.

• Ordina i dati nella tabella dati in formato Numero, Data e ora, Booleano o Stringa.

Data Table package alla pagina 1439

Nuova action nel package App Integration
Utilizza l'Acquisisci testo scorrevole action per estrarre il testo dalla finestra selezionata o da un
comando qualsiasi all'interno della finestra selezionata e salvarlo in una variabile. Se fai clic su un
controllo qualsiasi all'interno della finestra, viene estratto del testo da quel controllo specifico. Se fai
clic al di fuori della finestra, viene estratto tutto il testo da tale finestra.
App Integration package alla pagina 1398

Nuova opzione casella combinata di codifica in Terminal Emulator per la serie VT
Per inviare e ricevere testo in giapponese, puoi ora utilizzare le caselle combinate Codifica e
Pagina codice, nel momento in cui effettui il collegamento all'Emulatore terminale per il tipo di
terminale serie VT.
Using Connect action for Terminal Emulator alla pagina 1903
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Nuove funzionalità

New actions in Active Directory package
Utilizza quanto segue actions in Active Directory per automatizzare un'attività:
• Sposta un computer

Using the Move computer action alla pagina 1380
• Sposta un’unità organizzativa

Using the Move organizational unit action alla pagina 1385
• Aggiungi utenti a un gruppo

Using the Add users to group action alla pagina 1388
• Rimuovi utenti da un gruppo

Using the Remove users from group action alla pagina 1390

Nuova variabile di sistema per nuovo carattere di riga (ID caso Service Cloud: 00669232,
00672775, 00673578)
Utilizza la variabile di sistema $String:Newline$ per aggiungere un nuovo carattere di riga. Questa
variabile aggiunge un nuovo carattere di riga in varie applicazioni indipendentemente dal sistema
operativo del dispositivo.

Formato zero per Enterprise A2019 (ID caso Service Cloud: 00677611)
L'action Esegui utilizza il formato zero con il nome AAZeroSizeForm che può essere impiegato
dalle DLL per identificare i formati zero creati da Enterprise A2019.

Miglioramento per definire il percorso padre inActive Directory
Quando stabilisci una connessione con un server LDAP, puoi ora selezionare il percorso LDAP
connettendoti al server.
Using Connect action for Active Directory alla pagina 1383

Ottieni informazioni sull'utente Esegui-come dopo la distribuzione del bot
Use the AATaskExecutor system variable to return the username, first name, last name, and email
of the user that ran the bot. Se bot viene distribuito su un Bot Runner custodito, questa variabile
restituisce informazioni sull'utente connesso. Se bot viene distribuito da un trigger, questa variabile
restituisce informazioni sull'utente associato a tale licenza Bot Runner.
System settings and parameters alla pagina 2025

Miglioramenti al Recorder
• Universal Recorder ora supporta l'acquisizione di oggetti in Mozilla Firefox.

Devi installare l'estensione A2019 dai componenti aggiuntivi del browser Mozilla Firefox.
• Consente di acquisire oggetti di tabelle, griglie e finestre principali dalle applicazioni SAP.

Universal Recorder supported applications and browsers alla pagina 1958 | Actions performed on objects
captured with Universal Recorder alla pagina 1755

Dispositivo multi-utente supportato su Citrix Windows 10 Enterprise (ID caso Service
Cloud: 00526001)
Il server di dispositivi multi-utente è ora supportato su Windows 10 Enterprise su Citrix,
consentendo a più utenti di accedere allo stesso dispositivo contemporaneamente.
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Nuove funzionalità

Trigger di eventi su Bot Runners in modalità non assistita (ID caso Service Cloud: 00681548)
Assicurati di selezionare l'opzione Riutilizza una sessione esistente per le impostazioni di
accesso automatico in Control Room per utilizzare trigger di eventi su Bot Runners in modalità non
assistita quando un dispositivo è bloccato o è disconnesso (ad esempio RDP).
Configure auto-login settings alla pagina 2732

Auto Login supportato su Citrix VDI (ID caso Service Cloud: 00680200)
L'Auto Login è ora supportato su Citrix VDI e consente la distribuzione di bot in modalità non
assistita.
Configure auto-login settings alla pagina 2732.

Ripristino di bots da archivio Git
Se il database viene eliminato o danneggiato, l'utente Admin può ripristinare tutti i bots e i file
dipendenti dell'utente e associati dall'archivio Git al nuovo database vuoto.
Ripristino di bots da archivio Git alla pagina 2761

L'API di distribuzione bot verifica la presenza di dispositivi disponibili nell'ordine degli
ID pool elencati
Se si immettono più ID pool nel corpo della richiesta, l'API controlla i pool per verificare la presenza
di dispositivi disponibili nell'ordine in cui sono elencati gli ID pool. Se nessuno dei dispositivi è
disponibile al momento della distribuzione, l'automazione viene messa in coda.
Bot deploy API

Funzionalità modificate

Maggiore sicurezza per i dispositivi Bot Agent multi-utente (ID caso Service Cloud:
00695858)
Il Bot Agent configurato su dispositivi multi-utente per le distribuzioni basate su RDP utilizza ora la
versione aggiornata di wfreerdp.exe per una maggiore sicurezza.

Miglioramento delle API di distribuzione (ID caso Service Cloud: 00655548)
Quando richiami un'API di distribuzione regolare, se RunAsUser viene utilizzato per distribuire un
bot, l'API di distribuzione non distribuirà altri bots fino a quando RunAsUser non è libero di eseguire
gli altri bots.

La modifica dello stato avvia la distribuzione dell'automazione del carico di lavoro
Quando modifichi lo stato di un Work Item da Non riuscito a Nuovo in Control Room (Code),
viene avviata la distribuzione di un'automazione del carico di lavoro in coda.

Installa l'estensione offline per Enterprise Google Chrome con Bot Agent (Service Cloud
Case ID: 00623511, 00689623, 00715413)
Ora puoi installare l'estensione Google Chrome offline dai file di configurazione Bot Agent e MSI.
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Funzionalità modificate

ANSI come codifica predefinita nel Data Table package
Per le operazioni di scrittura di testo, package Data Table > l'action Scrivi su file supporta ANSI
come tipo di codifica predefinito.
I Bots creati con la versione precedente di Enterprise A2019 con UTF-8 non sono interessati da
questa modifica.

Miglioramenti al PDF package
Nel package PDF, quando immetti un intervallo di pagine errato nel campo Intervallo pagine ed
esegui il bot, viene visualizzato un messaggio di errore che richiede di fornire l'intervallo di pagine
corretto. Viene visualizzato il messaggio per il seguente actions:
• Unisci documento
• Dividi documento
• Estrai testo
• Estrai immagine

I Bots attendono il caricamento della pagina Web di Google Chrome
Durante l'automazione di un'attività nel browser Google Chrome, i bots attendono fino a 30 secondi
per il caricamento della pagina Web, quindi eseguono l'action Acquisizione > Registratore
successiva. Quando la pagina viene caricata, i bots cercano l'oggetto per la durata specificata nel
campo Attendi il controllo. L'attesa del rendering completo della pagina web aumenta la capacità
del bot di identificare l'oggetto target nella pagina web.

Miglioramento delle operazioni desktop
Quando crei un bot e selezioni un'opzione per l'operazione desktop, l'opzione selezionata rimane
invariata anche se navighi in altri campi.

Flow view updates in the Bot editor (Service Cloud case ID: 00701626)
• La vista Flusso è disabilitata quando si crea o si modifica un bot e il bot supera le 500 righe di

codice. Utilizza l'opzione Mostra vista elenco per passare alla visualizzazione dell'elenco.
• Nella visualizzazione Bot editor Flusso, viene visualizzato un messaggio di avvertenza quando il

bot supera le 400 righe di codice o se il bot ha più di 100 variabili.

La tabella seguente elenca i problemi risolti e le build in cui sono stati risolti (Build 8147 è la build più
recente e le build 8145, 8134, 8122 e 8098 sono le build precedenti). Le correzioni sono disponibili
cumulativamente nell'ultima build.

Problemi risolti

Numero di build ID caso Service Cloud Descrizione

8147 00737695 Quando si inserisce una variabile di sistema
in un campo action, la variabile viene ora
visualizzata in quel campo.

8147 00725978, 00727695 Quando si crea una variabile tabella in
On-Premises, la tabella si espande fino
alle dimensioni complete della finestra. In
precedenza la tabella mostrava solo tre righe
alla volta.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

8147 00733529,00739634 Non si verificano più problemi quando si
modifica un bot in Bot editor e si apre la
pagina di elenco dei packages. In precedenza,
se un package installato aveva un nome con
uno spazio (' ') all'interno, la pagina di elenco
dei package mostrava un errore.

8145 00727695 È ora possibile assegnare un bot dall'area di
lavoro privata a una variabile file.

8145 -- Quando si crea una variabile in una action, la
variabile viene visualizzata automaticamente
nel campo per il quale è stata creata.

8145 -- È ora possibile utilizzare file .png nelle actions
del package Image Recognition.

8145 00734972, 00734266 È ora possibile selezionare un file Control
Room file con lettere maiuscole nell'estensione
nell'action Riconoscimento delle immagini
> Trova l'immagine nella finestra.

8145 00734784 I nomi delle variabili vengono ora visualizzati
correttamente nella visualizzazione Elenco Bot
editor; le lettere maiuscole nel nome della
variabile non vengono più modificate in lettere
minuscole e i trattini non vengono modificati in
caratteri di sottolineatura.

8145 00734842, 00734999 Le Actions visualizzano ora le variabili
booleano, data/ora o tipo di elenco se il nome
della variabile contiene lettere maiuscole.

8145 00727228, 00722888,
00732830, 00732835,
00733877, 00733362,
00726489, 00733070,
732959, 733160,
733269, 733321,
733391, 733435,
733438, 733451,
733680, 733765,
733770, 733790,
733940, 734067

È ora possibile eseguire la distribuzione di
bots su un dispositivo multiutente quando
la sessione utente viene disconnessa e non
esiste alcuna sessione attiva (accesso, blocco
o disconnessione) per quell'utente o per
qualsiasi altro utente. The following error
message is no longer displayed on the View
historical activity (Activity > Historical)
page: Impossibile eseguire l'accesso
automatico per l'utente <nome
utente>.

8145 -- L'utilità di migrazione Cloud non continua più
a funzionare in background se viene chiusa
durante il caricamento dei dati Enterprise 11.

8134 00727031, 00730358,
00733607, 00733544,
00734642

È ora possibile eseguire correttamente i bots
quando si utilizza Image Recognition con
l'action Trova finestra nella finestra in un
bot figlio. In precedenza, l'esecuzione di un
bot non riusciva quando è veniva utilizzata la
Image Recognition con questa action nella
sottoattività.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

8134 00733263, 00733459,
00733007, 00733988,
00734168, 00733141,
00733074, 00733087,
00733001, 00734019

Data Table, List e Loop packages supportano
ora variabili con nomi di casi scritti con
notazione a cammello.

8122 00713867 Le variabili sono ora elencate in ordine
alfabetico nella tavolozza variabili e nella
finestra Inserisci un valore visualizzata
quando si preme il tasto F2.

8122 -- La Control Room non richiede ora più tempo
per l'avvio e non viene più visualizzato
il seguente messaggio di errore: Si è
verificato un problema imprevisto.

8098 00689022, 00697417,
00697420, 00697079

Un dispositivo Bot Agent non si disconnette più
da una Control Room configurata su Microsoft
Azure. Non viene più visualizzato il seguente
messaggio di errore: Disconnessione
dovuta a pong straordinario.

8122 00719167, 00721731 Attività quali la pianificazione di bots e la
connessione ai dispositivi utente non subiscono
ritardi in una Control Room ospitata su Cloud.

8098 00626595, 00680433 Le actions nel package Image Recognition
non restituiscono più un messaggio di errore
errato relativo al tipo di dati immagine di
destinazione.

8098 00698201 È stato risolto un problema in cui i bots
rimanevano bloccati in modalità di pre-
elaborazione quando il bot veniva utilizzato
come bot figlio in diversi bots in esecuzione
o era stato ridistribuito utilizzando l'API di
distribuzione. Ora i bots vengono distribuiti
dalla cache e vengono effettuate meno
chiamate al database, evitando così un blocco
del database.

8098 -- Il Bot Scanner visualizza ora il messaggio
corretto per la logica MetaBot che contiene
variabili delle credenziali che non possono
essere migrate a Enterprise A2019.

8098 00687223 Un bot Enterprise 11 che passa un valore
vuoto come input alla stringa, all'elenco, alla
matrice monodimensionale e alla matrice
bidimensionale della variabile tipo stringa
utilizzata in una DLL non rileva più un errore
quando tale bot viene eseguito dopo la
migrazione a Enterprise A2019.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

8098 00677231 Un bot non risponde più se contiene un action
per chiudere il browser Google Chrome seguito
da un action per aprire il browser Google
Chrome.

8098 00687207 Quando un bot Enterprise 11 contiene oggetti
acquisiti utilizzando il comando Object Cloning
e tale oggetto ha una proprietà che contiene
un'espressione all'interno del carattere $, il bot
Enterprise 11 non rileva più un errore dopo la
migrazione.

8098 00689286 Il Bot Scanner non rileva più un errore quando
si esegue la scansione di un bot Enterprise 11
che contiene il comando If con la condizione
Controllo delle finestre selezionata e rende
automatica un'attività su un file Microsoft
Excel.

8098 00706438 Non si verifica più un errore durante
l'installazione di Enterprise A2019 e:
• Si sta effettuando la migrazione da

Enterprise 11 a Enterprise A2019
• Active Directory è configurato su Enterprise

11 Control Room
• Il database Enterprise 11 ripristinato

contiene il ruolo AAE_Meta Bot Designer

8098 00708522 Non si verifica più un errore quando si clona
un file dipendente di un bot Enterprise 11 dopo
la migrazione a Enterprise A2019. L'errore si
verifica solo quando il bot migrato contiene
una descrizione nulla.

8098 00626664 Puoi ora migrare le attività automatizzate bots
nelle applicazioni BMC. I bots migrati utilizzano
l'action Automazione legacy > Gestisci
controlli Web per automatizzare le interazioni
con gli oggetti.

8098 -- Puoi ora selezionare l'opzione di espressione
regolare Senza distinzione tra maiuscole
e minuscole nelle actions che contengono
un campo del titolo della finestra ed eseguire
correttamente una nuova acquisizione nella
finestra dell'applicazione.

8098 00688134 Nel package Database, i caratteri coreani
vengono ora visualizzati correttamente quando
si utilizza l'action Inserisci/Aggiorna/
Elimina in un file Excel. In precedenza, i
caratteri coreani non venivano visualizzati
correttamente quando action veniva utilizzato.

© 2023 Automation Anywhere. All rights reserved.     456



    Automation Anywhere - Learn

Problemi risolti

Numero di build ID caso Service Cloud Descrizione

8098 00675749 In Email package, puoi ora inoltrare un'e-mail
utilizzando groupId o alias. In precedenza, le
e-mail non venivano inviate dal server SMTP se
l'indirizzo e-mail conteneva groupId o alias nel
campo A.

8098 -- Puoi ora utilizzare una doppia barra rovesciata
(\\) nell'action Invia testo del Terminal
Emulator ed eseguire i bots. In precedenza,
quando veniva utilizzata una doppia barra
rovesciata (\\) in questa action e il bot veniva
eseguito, il terminale mostrava una singola
barra (\).

8098 00688692 Quando ti connetti al server EWS per
leggere le e-mail utilizzando Loop, l'e-mail
recuperata in quel momento visualizza il
contenuto correttamente in base alla modalità
selezionata (formati HTML o testo normale). In
precedenza, quando effettuavi la connessione
al server EWS per leggere un'e-mail in formato
HTML, il corpo dell'e-mail visualizzava un
output vuoto.

8098 00659456 Nel package Loop, quando selezioni Per ogni
file nella cartella come opzione Iteratore,
la Nota sotto il campo Assegna nome file
ed estensione a questa variabile visualizza
ora il nome chiave in inglese. Previously, the
key name in the Note was translated to the
languages you selected.

8098 -- Un bot non viene più eseguito in modo
intermittente quando la messa a fuoco passa
da una finestra all'altra e non visualizza l'errore
del plug-in Google Chrome Type_015.

8098 00683528 Nel package Database, le singole voci vengono
ora inserite nel database quando esegui una
procedura di memorizzazione per aggiungere
righe nella tabella e l'opzione Esporta dati
in CSV è selezionata. In precedenza, nel
database erano state aggiunte voci duplicate.

8098 00693664 È stato risolto un problema per cui i caratteri
giapponesi non venivano visualizzati
correttamente quando venivano immessi in un
campo contenente una variabile.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

8098 00677167 La scheda locker Partecipanti ora mostra
solo i partecipanti assegnati per quel locker
specifico. In precedenza, la scheda visualizzava
i partecipanti del locker precedentemente
visualizzato, richiedendo all'utente di
aggiornare il browser per visualizzare i
partecipanti corretti.

8098 -- I servizi Control Room possono ora essere
eseguiti utilizzando gli utenti dell'account di
servizio non amministratore. Il messaggio
di Gateway non valido non viene più
visualizzato.

8098 00691232 È stato risolto un problema che non consentiva
agli utenti di aggiornare il valore di una
variabile di input del tipo di file dopo il
salvataggio del bot.

8098 -- L'opzione Salva ora è abilitata correttamente
quando gli utenti apportano modifiche ai
metadati, all'entità univoca e/o alla modalità di
asserzione SAML.

8098 -- Il nome utente non viene più salvato nella
finestra di accesso dopo che l'utente si è
disconnesso, a meno che l'utente non abbia
selezionato l'opzione Ricorda il mio nome
utente.

8098 00682021 Quando effettui il check-in di un bot che
ha clonato i bots come dipendenze, i file
dipendenti dello spazio di lavoro privato non
vengono più persi. Inoltre, dopo il check-
in, se crei un nuovo bot utilizzando le stesse
dipendenze del precedente bot, il nuovo bot
viene eseguito correttamente.

8098 -- I Work Items ora vengono elaborati per
l'automazione del carico di lavoro dopo aver
aggiunto altri Work Items a una coda esistente.

8098 -- I Work Items ora vengono rielaborati per
l'automazione del carico di lavoro dopo aver
modificato lo stato da non riuscito a nuovo.

8098 00711410 È ora possibile eseguire la migrazione delle
automazioni dei carichi di lavoro in una Control
Room configurata per utilizzare una modalità
manuale per Credential Vault.
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Numero di build ID caso Service Cloud Descrizione

8098 00667047, 00673289 L'accesso automatico per una sessione utente
non ha più esito negativo per bots distribuiti
su macchine virtuali quando la sessione
VDI è disconnessa o è in stato bloccato e
il messaggio di errore del token non viene
più visualizzato: È stato fatto un
tentativo di fare riferimento a un
token che non esiste.

8098 00560593, 00585092 Universal Recorder è ora allineato con Bot
Agent, in modo che il registratore possa
acquisire oggetti sui dispositivi con qualsiasi
configurazione del server proxy.

8098 00675695 Quando si utilizza il package Excel advanced,
il bot apre ora un file Excel senza problemi.
In precedenza, i bots non riuscivano ad aprire
un file Excel in alcuni scenari a causa di
componenti hardware interni.

8098 00678567 Voci in formato CSV non sono più consentite
nei campi dati delle applicazioni Web, ad
esempio i nomi dei dispositivi. Questi campi
possono accettare solo caratteri alfabetici,
numeri, trattini e caratteri di sottolineatura.

8098 00691551 I caratteri turchi sono ora supportati nei nomi
utente.

Limitazioni note

Quando si aggiorna Bot Agent da livello utente a livello sistema, l'utente non è in grado di acquisire
oggetti utilizzando le azioni del registratore o da un elenco di finestre in un browser Google
Chrome.
Soluzione: Rimuovere la voce di registro per l'utente. Assicurarsi che la voce di
registro sia in HKLM: Computer\HKEY_CURRENT_USER\SOFTWARE\Google\Chrome
\NativeMessagingHost\Automation*.

Quando si disinstalla Bot Agent, il servizio Bot Agent e la voce di registro non vengono rimossi.
Pertanto, le successive reinstallazioni di Bot Agent non riescono.
Soluzione:
1. Arrestare il servizio Bot Agent da Gestione attività.
2. Eliminare la chiave di registro Bot Agent da Computer\HKEY_LOCAL_MACHINE\SYSTEM

\ControlSet001\Services\Automation Anywhere Bot Agent.
3. Reinstallare Bot Agent.

Quando si installa un Bot Agent a livello utente, il dispositivo utente non viene registrato come
amministratore.
Soluzione: Prima di installare Bot Agent, assicurarsi che l'utente disponga dell'autorizzazione di
scrittura per le cartelle del profilo utente (ad esempio , C:/Program Files).
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Limitazioni note

Quando si distribuisce un bot utilizzando un package personalizzato, se il package contiene un
nome di oggetto con un carattere punto e virgola (;) o percentuale (%), l'esecuzione del bot non
riesce.
Soluzione: Non utilizzare caratteri speciali come un punto e virgola (;) o percentuale (%) nel
nome personalizzato del package.

Limitazione per distribuzioni multi-utente con accesso automatico
Se l'impostazione di accesso automatico in Control Room è impostata per bloccare la sessione al
termine dell'esecuzione del bot da una sessione sbloccata esistente, le distribuzioni non andranno a
buon fine quando un bot viene distribuito su un dispositivo multiutente nell'ambito di una sessione
utente non amministratore e sul dispositivo è attiva anche un'altra sessione utente amministratore.
Soluzione: Restart the Bot Agent service from the Windows Start menu and log off from the
admin user session.

Installazione di Bot Agent
A partire da questa versione, quando si installa il Bot Agent a livello di utente locale, tieni presente
quanto segue:
• Non puoi installare il Bot Agent al livello di utente se accedi al dispositivo come amministratore.
• L'accesso automatico non è supportato per gli utenti locali e i Bot Runners in modalità non

assistita.
• La funzione di aggiornamento automatico per il Bot Agent sarà applicabile dalla versione

successiva poiché l'opzione per installare il Bot Agent a livello di utente locale è stata introdotta
in questa versione.

• Non è possibile configurare dispositivi multiutente.
• Registratori Enterprise A2019 per applicazioni di terze parti:

• Non è richiesta alcuna configurazione separata per JRE 6 e 7.
• Citrix XenApp non è supportato perché per configurare Citrix sono richiesti i privilegi di

amministratore.
• È necessario eseguire l'aggiornamento al pacchetto Recorder Enterprise A2019.19 per

utilizzare Discovery Bot.
• È necessario disporre dell'autorizzazione di scrittura per i registri AISense Recorder.

I Bots riscontrano un errore di spazio dell'heap Java quando utilizzano il package Excel basic per
aprire un file Excel di dimensioni pari o superiori a 20 MB.
Soluzione: Aumentare lo spazio dell'heap della macchina virtuale Java a 8 GB:
1. Accedi a C:\Program Files\Automation Anywhere\Bot Agent\config.
2. Se non esiste già, crea un nuovo file di testo denominato nodemanager.properties.
3. Open the file and copy the following text and paste it in the file:

bot.launcher.jvm.options=-Xmx8092m

4. Apri Servizi Windows e riavvia Bot Agent.

I Bots attendono 30 secondi affinché un oggetto venga visualizzato nel browser Google Chrome,
indipendentemente dal valore nel campo Attendi il controllo nell'action Registratore >
Acquisizione.
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Limitazioni note

Limitazioni alla migrazione al Cloud
• Il backup dei dati Enterprise 11 creati dall'utilità di migrazione al Cloud non viene eliminato

quando l'utilità di migrazione al Cloud viene chiusa dopo che i dati Enterprise 11 sono stati
caricati sul Cloud.

• I bots Enterprise 11 che contengono caratteri giapponesi nel loro nome presentano un errore
quando i bots vengono eseguiti dopo la migrazione al Cloud.

• L'utilità di migrazione al non mostra un errore di convalida quando si esegue l'Cloud non mostra
un errore di convalida quando si esegue l'utilità e il servizio Automation Anywhere Control Room
Reverse Proxy è in esecuzione se la Control Room Enterprise 11 è stato reinstallata utilizzando lo
stesso database utilizzato nell'istanza Enterprise 11 precedente.

(ID caso Service Cloud: 00737669) Quando si esegue l'aggiornamento a questa versione, viene
aggiornato anche il Bot Agent. Di conseguenza, tutti i trigger di evento associati agli utenti Bot
Runner (presenti o non assistiti) vengono arrestati.
Soluzione: Gli utenti Bot Runner (presenti e non assistiti) devono accedere nuovamente a Control
Room per attivare i trigger degli eventi associati.

bots Enterprise 11 che utilizzano nomi identici per le variabili differenziate da un trattino o da un
trattino basso (ad esempio, L-inferiore e L_inferiore) riscontrano un errore quando li si eseguono
dopo la migrazione a Enterprise A2019.
Soluzione: Aggiornare il nome di una delle variabili con un nome diverso prima di migrare il bot.

Le variabili del sistema stringa non funzionano nei campi action Email quando il formato è
impostato su HTML.
Soluzione: Utilizzare tag HTML che eseguono la stessa funzione delle variabili stringa. For
example, instead of $String:Enter$ or $String:Newline$, you can use the HTML tag <br>.
Similarly, for the string variable $String:Tab$, you can enter &nbsp.

Quando si inserisce una variabile in un campo action che contiene altri contenuti, la variabile viene
visualizzata alla fine del contenuto, indipendentemente dalla posizione del cursore.
Soluzione: Evidenziare il nome della variabile, quindi tagliarla e incollarla nella posizione corretta
nel campo action.

(ID caso Service Cloud: 00781974) In a Linux environment, some of the Control Room
log messages are stored in the /var/log/messages file instead of the /var/log/
automationanywhere directory. As a result, disk space increases, and the services might stop
when the disk space is full.
Soluzione: Clear the messages file regularly to avoid a disk storage issue.

Automation Anywhere Robotic Interface (AARI)

Nuove funzionalità

Nuova attività di filtro nell'editor di processo
Nell'editor di processo, Attività di filtro consente agli utenti di filtrare variabili come l'output
umano o l'output di un'attività bot con un criterio di filtro specifico.
Crea un processo AARI alla pagina 2133
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Nuove funzionalità

Nuova attività di processo nell'editor di processo
Utilizza la nuova opzione Attività di processo nell'editor di processo per richiamare un
sottoprocesso all'interno del processo principale. Questa procedura aiuta a separare le attività in
processi diversi, invece di includere tutte queste attività in un unico processo. Più team possono
ora lavorare contemporaneamente su diverse attività all'interno del processo principale e rimanere
separati, senza conflitti.
Crea un processo AARI alla pagina 2133

Nascondi un'attività o visualizza un'attività nascosta
Con una licenza Bot Creator, puoi ora eseguire le seguenti operazioni:
• Nascondi la visualizzazione di attività umane e bot selezionando l'opzione Nascondi questa

attività dopo il completamento nell'editor di processo.
• Visualizza un'attività umana o bot nascosta selezionando l'opzione Visualizza attività

nascoste nella pagina di visualizzazione delle attività.

Crea un processo AARI alla pagina 2133

Modifica titolo nell'editor di processo
Gli utenti possono ora modificare il titolo nell'editor di processo.

Aggiornamenti dell'editor di testo RTF (interfaccia Web)
Nell'interfaccia Web, è possibile utilizzare funzioni di editor di testo avanzato come testo in
grassetto, corsivo, sottolineato, allineamento, formattazione, colore e dimensioni nelle attività.

Aggiornamenti degli elementi della tabella (interfaccia Web)
Nell'interfaccia Web, l'elemento Tabella supporta ora l'uso di data, numero, elenco a discesa e
valori di testo nelle attività.

Aggiornamenti degli elementi nel generatore di moduli
Il generatore di moduli ora include i seguenti nuovi elementi:
• Elemento Seleziona cartella: Aggiungi un'opzione di cartella di caricamento nel modulo.

Using the Select Folder element alla pagina 2194
• Elemento Collegamento ipertestuale: Assegna un URL nel modulo.

Using the Hyperlink element alla pagina 2195

Miglioramento del trigger di azione Casella di controllo
Se un modulo con un elemento Casella di controllo viene utilizzato all'interno di un loop di
attivazione package, puoi ora utilizzare le actions di attivazione Valore selezionato e Valore non
selezionato .
Trigger loop package alla pagina 1917
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Funzionalità modificate

Crea e visualizza le richieste (manager AARI)
Un manager AARI può creare e visualizzare richieste dai processi assegnati al team a cui appartiene
o di cui è proprietario. Possono anche creare e visualizzare richieste dai processi che sono assegnati
ad essi ma non al team.

Lo stesso dispositivo non può essere assegnato a Bot Creator e a Bot Runner non
assistito per i trigger
Quando esegui l'aggiornamento a questa versione di Enterprise A2019 da una versione precedente,
un dispositivo predefinito associato a un Bot Creator o a un Bot Runner assistito non può essere
associato a un Bot Runner non assistito per la distribuzione dei trigger.
Azione consigliata: Utilizzare dispositivi o credenziali di dispositivo separati (accesso automatico)
per Bot Creator e Bot Runner assistiti poiché le distribuzioni possono sovrapporsi o sovrascrivere le
licenze.

Creare un'azione richiesta URI
Il selettore di processo nell'azione Crea una richiesta viene sostituito da un identificatore di
risorse uniformi (URI) dell'archivio pubblico.
AARI Web package alla pagina 1369

Problemi risolti

Numero di build ID caso Service Cloud Descrizione

8134 -- L'elemento della tabella ora esegue
correttamente il rendering anche quando
il valore del parametro Riga prima dello
scorrimento non corrisponde al numero di
righe. In precedenza, il rendering della tabella
non era corretto e visualizzava celle vuote.

8122 -- Quando si esegue l'estrazione di un processo e
si aggiungono, modificano o rimuovono attività
nell'editor di processo, le dipendenze vengono
aggiornate correttamente quando il processo
viene sottoposto ad archiviazione.

8098 00707684, 00707688,
00707192, 00706781,
00707900, 00709109

Tutti i trigger di eventi vengono ora conservati
quando aggiorni questa versione da una
versione precedente.

8098 -- Nell'editor di processi, le funzioni di
annullamento e ripetizione sono ora disponibili
per le interazioni del canvas e del pannello
delle proprietà in base all’impostazione
predefinita. In precedenza, le funzioni di
annullamento e ripetizione erano disponibili
solo per le interazioni canvas.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

8098 -- In precedenza, durante il tempo di esecuzione
del bot, se tutte le righe esistenti venivano
eliminate da una tabella prima di aggiungere
una nuova riga, le colonne e le righe della
tabella non erano allineate correttamente.
Puoi ora trascinare e ridimensionare qualsiasi
colonna per ripristinare l'allineamento della
tabella.

8098 -- Tutti gli eventi trigger all'interno di un modulo
vengono ora conservati e non hanno più esito
negativo quando il modulo viene chiuso e
riaperto durante il tempo di esecuzione del bot.

8098 -- Nell'editor di processo, se sostituisci l'opzione
Vai a con un'opzione Termina processo,
l'icona Termina processo mostra ora lo stato
corretto (Completato, Non riuscito, Annullato).
In precedenza, lo stato non veniva visualizzato
correttamente e doveva essere modificato
manualmente utilizzando l'opzione Termina
processo.

8098 -- Quando elimini una richiesta dalla scheda
Richiesta e questa viene inviata al cestino,
l'attività correlata dalla scheda Attività viene
rimossa.

8098 -- Quando filtri le attività nella scheda Attività, i
risultati mostrati nella scheda ora conservano
le informazioni quando navighi tra le diverse
schede.

Funzionalità obsolete

Supporto rimosso per la configurazione del pool di dispositivi
Un amministratore AARI non può più utilizzare la configurazione del pool di dispositivi per la
distribuzione di bots in un processo. After upgrading to Enterprise A2019.19 from an earlier version,
verify that the scheduler user configuration is set up in order to successfully execute your bots in
the process.
Configure scheduler user for AARI on the web alla pagina 2118

Limitazioni note

Quando si crea una richiesta da un processo (pubblico o privato) e si inseriscono tutte le
informazioni richieste nel modulo iniziale, il modulo iniziale non può essere inviato perché l'opzione
Invia non funziona. Questo problema si verifica per tutti i moduli iniziali con almeno un campo
obbligatorio.
Soluzione: Rendere tutti i campi facoltativi.
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Limitazioni note

Quando invii un modulo o un'attività iniziale in una vista di richiesta che contiene una casella di
controllo con almeno due opzioni e almeno un'opzione selezionata, il valore della casella di controllo
non viene modificato e per impostazione predefinita viene impostato su un valore booleano falso.

If the Set action is used immediately after a Get action, the value assigned to a variable using the
Get action is not retrieved in the specified form element of the Set action during bot runtime.

Un manager AARI può creare una richiesta da un processo assegnato a lui, ma non al suo team.
È possibile creare e completare la richiesta se il processo contiene solo attività bot. Se il processo
contiene un'attività umana, il manager non può assegnarla a se stesso.
Soluzione: Assegna il processo sia al manager che al team.

Nell'editor di processo, l'opzione Vai a mostra solo Attività umana e Attività del bot, non
mostra Attività di filtro o Attività processo.

(ID caso Service Cloud: 00736309, 00765069, 00784362) If you use a file trigger for a document
that is in .csv, .xlsx, or .xls format, the corresponding bot is not triggered when that
document is modified.

Discovery Bot

Nuove funzionalità

Visualizza la durata di ogni fase registrata
Viene ora visualizzata una fase registrata in minuti e secondi per l'utente e l'analista aziendale.
Utilizza queste informazioni per comprendere quali sono i passaggi che costituiscono un collo di
bottiglia nel processo corrente e che garantiranno il massimo beneficio dall'automazione. La durata
della fase viene visualizzata dalla pagina Registrazioni (sotto l'immagine dello screenshot) e dalle
pagine Visualizza processo e Visualizza opportunità nella finestra del riquadro Anteprima.
Registrare un processo aziendale Discovery Bot alla pagina 2348

Funzionalità modificate

Miglioramento dello screenshot
L'immagine dello screenshot della fase registrata viene ora aumentata a dimensione intera per una
visualizzazione più chiara e dettagliata.

Problemi risolti

ID caso Service Cloud Descrizione

-- Ora è sufficiente fare clic sull'icona Schermo
per visualizzare un'immagine nascosta e salvata.
Previously, you had to click Screen and then
click Save to display the image again.
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Problemi risolti

ID caso Service Cloud Descrizione

-- Quando viene creata un'opportunità per
una vista generata dal sistema con filtri
applicati, il filtro ora rimane presente nella vista
visualizzata nella scheda Aggregato della
pagina Opportunità. The filter is not reapplied
on the view from the Opportunities page and
the No recording data message is no longer
displayed.

-- Quando annulli una registrazione, la
registrazione non viene visualizzata nel riquadro
del processo in Ciclo del processo.

-- Puoi ora approvare una registrazione con 2000
fasi. Lo stato di Registrazione viene visualizzato
come approvato.

Limitazioni note

Azioni come doppio clic, trascinamento, fare clic e tenere premuto e selezione del testo non sono
supportate quando si registra un processo aziendale.

IQ Bot

Nuove funzionalità

Supporto per variabili in IQ Bot actions (ID caso Service Cloud: 00511178)
IQ Bot On-Premises e Cloud
Ora puoi utilizzare le variabili nelle actions Scarica tutti i documenti e Carica documento nel
IQ Bot package.
Create a variable alla pagina 2030 | IQ Bot package alla pagina 1662

Funzionalità modificate

Rinomina un'istanza di apprendimento (ID caso Service Cloud: 00675803)

Puoi ora rinominare un'istanza di apprendimento in staging in IQ Bot.

Elaborazione sequenziale dei documenti (ID caso Service Cloud: 00662968, 00665331)
Quando fai clic su Vedi risultati estrazione, IQ Bot apre tale richiesta in una nuova scheda del
browser visualizzandone il numero nella coda. Questo numero continua a diminuire man mano che
le richieste precedenti in coda vengono elaborate.

Supporto per l'olandese
IQ Bot ora supporta la lingua olandese con ABBYY FineReader Engine.
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Funzionalità modificate

Configurare le impostazioni OCR utilizzando API REST
Un utente con il ruolo di amministratore AA IQ Bot può ora utilizzare l'API appConfigurations
per leggere e aggiornare le impostazioni OCR.
Select an OCR engine

Problemi risolti

ID caso Service Cloud Descrizione

00639117 Il formato numerico nella lingua polacca è ora
accettato in IQ Bot e Validator.

-- Quando carichi un documento in produzione
immediatamente dopo l'eliminazione di un bot
a cui era associato, i risultati dell'estrazione
vengono ora visualizzati a prescindere da
quando il bot era stato eliminato. In precedenza,
era necessario un intervallo di 3 minuti per
visualizzare i risultati di estrazione del bot
eliminato.

00636899, 00683451 Quando crei un'istanza di apprendimento
utilizzando il dominio personalizzato, i nomi dei
campi ora vengono visualizzati correttamente,
indipendentemente dalla lingua del dominio
personalizzato.

00459301, 00677204, 00532325, 00658245 La logica Python personalizzata visualizza ora i
risultati di estrazione in Designer senza errori.

00657928, 00679540 I file dell'archivio IQ Bot esportati (.iqba) non
contengono più record non necessari nei file .csv.

00704365 Se i documenti caricati durante la produzione
hanno meno pagine rispetto ai documenti di
gestione temporanea con cui il bot è stato
formato, questi documenti di produzione
vengono ora elaborati senza errori.

00703560, 0062442 Quando si migrano istanze di apprendimento
utilizzando l'opzione Aggiungi, tutti i
record vengono migrati correttamente,
indipendentemente dal numero di record nel file
IQBA.

00715124 IQ Bot ora elimina i file temporanei scaricati dal
server Amazon S3 nella cartella C:\windows
\temp quando non sono più necessari. Di
conseguenza, l'archiviazione non viene più
utilizzata da questi file temporanei.

00686297 I servizi di apprendimento automatico IQ Bot
vengono ora installati correttamente al momento
dell'installazione di IQ Bot.
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Problemi risolti

ID caso Service Cloud Descrizione

00657928, 00679540, 00727633 Ora è possibile migrare le istanze di
apprendimento alla produzione, anche se
contengono documenti non classificati.

Limitazioni note

IQ Bot On-Premises e Cloud
Facendo più volte clic su Vedi i risultati dell'estrazione, si apre la pagina Elenco delle istanze
di apprendimento invece dei risultati dell'estrazione.

IQ Bot On-Premises e Cloud
Durante la creazione di una tabella nella pagina Designer, se fai clic su Vedi risultati estrazione
senza completare la creazione della tabella, i risultati dell'estrazione non vengono visualizzati.
Soluzione: Creare prima la tabella, quindi fare clic su Vedi risultati estrazione.

IQ Bot On-Premises e Cloud
Viene visualizzato un messaggio di errore quando aggiorni la pagina dei risultati dell'estrazione per
un'istanza di apprendimento, quando il bot associato viene spostato in produzione.

IQ Bot On-Premises e Cloud
Quando un bot viene eliminato, viene visualizzato un messaggio di errore non corretto quando fai
clic sull'opzione Prova bot nella pagina Elenco bot.

IQ Bot On-Premises e Cloud
Se rinomini un'istanza di apprendimento in produzione e scarichi i file, vengono scaricati anche
tutti i file associati all'istanza di apprendimento originale. Ad esempio, se rinomini un'istanza di
apprendimento da Sales1 a Sales2, tutti i file associati a Sales1 vengono scaricati anche quando
scarichi Sales2.

IQ Bot On-Premises e Cloud
Se hai a disposizione più istanze di apprendimento e fai clic su Vedi risultati estrazione per tutti,
i risultati dell'estrazione non vengono elaborati nell'ordine della richiesta.

IQ Bot On-Premises e Cloud
Quando crei un'istanza di apprendimento con i campi delle caselle di controllo ed esegui uno script
Python associato alla casella di controllo, nella pagina Designer viene visualizzato un messaggio di
errore.

IQ Bot On-Premises e Cloud
Quando si caricano documenti di gestione temporanea o di produzione in un'istanza di
apprendimento, i file temporanei vengono creati nella cartella C:\Windows\Temp e le dimensioni
della cartella potrebbero aumentare in un certo periodo di tempo. Pertanto, elimina manualmente i
file da questa cartella poiché IQ Bot potrebbe smettere di rispondere.
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Limitazioni note

IQ Bot On-Premises e Cloud
Selezionando l'opzione Solo per me durante l'installazione di Bot Agent, l'action Estrazione IQ
bot presenta i seguenti problemi:
• L'elaborazione di un documento richiede molto tempo.
• Alcuni documenti potrebbero non essere elaborati correttamente.

Soluzione: Durante l'installazione di Bot Agent, scegliere l'opzione Chiunque utilizzi questo
computer (tutti gli utenti).

IQ Bot On-Premises
(Caso Service Cloud: 00762174) L'utilizzo di Database Migration Assistant per eseguire la
migrazione da IQ Bot 11.x (cinque database) ad A2019 (database unificato) in Microsoft Azure
Database non è supportato.

IQ Bot On-Premises e Cloud
When you change the display language of any learning instance that has a document in Validator,
although the selected display language is successfully applied to the learning instance, an error
message is still displayed.

IQ Bot Cloud
The auto-correction and auto-suggestion features, which are part of the MLScheduler service, use
system resources extensively and cause the system to slow down or stop responding.

Funzionalità obsolete

IQ Bot On-Premises non è più supportato in Windows Server 2012.

Bot Insight

Problemi risolti

ID caso Service Cloud Descrizione

00669196 Quando applichi filtri di data a un dashboard e
quindi applichi il filtro di attributo nel widget,
questi vengono filtrati per una data specifica.
In precedenza, il filtro della data applicato a
livello di dashboard veniva ignorato quando il
filtro dell’attributo veniva selezionato a livello di
widget. Di conseguenza, venivano visualizzati
anche i dati cronologici.

Importante:  Le informazioni sui pacchetti supportati vengono spostate in questo argomento: View
package versions available in the Control Room alla pagina 2009.
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Note su Enterprise Edition A2019.18
Data di rilascio: 11 January 2021

Review the new features, changed features, fixed features, known limitations, and supported packages in
the Enterprise A2019.18 (Build 7560) release. For IQ Bot, Build 7553 is available for Cloud customers and
Build 7554 is available for On-Premises customers. There are no security fixes in this release.

Importante:  We have updated Enterprise A2019.18 to Build 7560 to include fixes for issues with
workload management (Service Cloud case IDs 00696614 and 00703339) and SSO authentication on
Automation Anywhere Cloud (Service Cloud case IDs 00706042, 00706074, 00706201, 00706195,
00706134, 00706022, and 00707033). See the Fixed features section for more information.

• Funzionalità di migrazione alla pagina 470
• Enterprise A2019 alla pagina 471
• AARI
• Discovery Bot alla pagina 483
• IQ Bot alla pagina 485
• Bot Insight alla pagina 487
• Pacchetti supportati alla pagina 487

Funzionalità di migrazione

Funzionalità di Enterprise 11 e Enterprise 10

Esegui la migrazione dei MetaBots con le schermate
Migrare MetaBots che contengono schermi come asset. You can migrate screens based on HTML,
MSAA, and .NET technologies and captured using the Object, Image, and Coordinate play
modes.

Configure timeout in Bot Migration package
When migrating bots, you can now set a timeout value in the range of 3 through 90 minutes
(default value is 90 minutes). If the migration of any specific bot is not completed within the set
time, a timeout message is displayed and the migration process moves to the next bot.

Use regular expressions in variables (Service Cloud case ID: 00628227)
Use regular expressions (regex) in value type variables to specify the entity on which you want to
perform an operation. For example, actions in the File, Folder, String, and Window packages allow
use of regular expression in variables.
When Enterprise 11 or Enterprise 10 bots with commands that use regular expressions in variables
are migrated, if their equivalent actions in Enterprise A2019 do not support regular expressions, the
regular expression is converted to string in the migrated bots.

Migrate MetaBot that returns a list variable
You can now migrate MetaBots that contain logic that return a list variable to the parent bot.

Migrate bots that use functional keys
Migrate bots that use functional keys such as F1, F2, and F3 in the Send Text command.
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Funzionalità di Enterprise 11 e Enterprise 10

Migrate bots that extract information from PDF
Migrate bots that use the Extract Form Fields command to extract data from the fields in a PDF
file.

Funzionalità esclusive di Enterprise 11

Migrate bots to Enterprise A2019 Cloud
You can now migrate to Enterprise A2019 Cloud by using the Cloud Migration Utility. Use the utility
to upload your Enterprise 11 data to Automation Anywhere Cloud.
Migrate from 11.x to Cloud

Migrate to Enterprise A2019 on Linux CentOS (Service Cloud case ID: 00654757)
You can now migrate from Enterprise 11 to Enterprise A2019 installed on Linux CentOS.
Migrate to Linux CentOS

Migrate imported Enterprise 11 bots to Enterprise A2019
You can now migrate Enterprise 11 bots that you imported using the Bot Lifecycle Management
feature or the Import API to Enterprise A2019 by using the migration wizard.

Migrazione di bots che utilizzano i seguenti attributi:
• Bots that use regular expression (regex) to search for the string and title of an application

window on which you want to perform an operation
• (ID caso Service Cloud: 00616115) Bots for which custom format is configured for system

dates
The system uses the AADefaultDateFormat global value to store the format of the date.

• Bots that use the Search Field command to search a field index or field name by using text in
the Terminal Emulator

Enterprise A2019

Importante:  This release includes a required update to your . Ensure that you complete the update to
continue with your automation activities when upgrading from a previous release to this release.
Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina
1043

To verify which  version is compatible with this release, see Compatibility with release builds alla pagina
1026.

© 2023 Automation Anywhere. All rights reserved.     471



    Automation Anywhere - Learn

Nuove funzionalità

Create a Citizen Developer user
Administrators can now use the Citizen Developer license to create Citizen Developer roles and
users in the Control Room. Gli utenti con questa licenza possono creare ed eseguire i bots (anche
bots con trigger) sui loro dispositivi.
Licenze Automation 360 alla pagina 1010 | Create a Citizen Developer role alla pagina 2707 | Create a
Citizen Developer user alla pagina 2689

Recorder enhancements
• Use the AISense Recorder Define option to record an interaction, such as click active text, with

an object that is only visible when you hover the mouse over the object.
• If you record a click and keystrokes in a text box with a Control Type of PASSWORD_TEXT,

the Recorder does not capture the keystrokes entered into the field. Instead, the action selects
the Set text option and offers users the option to select a credential from the Credential Vault,
enter a credential variable, or enter an insecure string.

Export and import Bot Insight dashboards using Bot Lifecycle Management
The Bot Lifecycle Management feature now enables you to export and import Bot Insight
dashboards (default, custom, and published) associated with analytics bots from one Control Room
instance to another. You can also export and import Bot Insight dashboards using the Bot Lifecycle
Management export and import APIs.
Esporta bots alla pagina 2835 | Importa bots alla pagina 2837

Support for non-persistent VDI
Non-persistent virtual desktop infrastructure (VDI) is now supported for temporary devices so
that you can configure settings for temporary devices in the Control Room or during Bot Agent
installation.
The feature includes the following capabilities:
• Automatically register a device.
• Automatically mark a device as default for the logged-in user.
• Automatically add a device to an existing pool.
• Delete offline devices from a list of devices.
• Add parameters for temporary devices in the Bot Agent MSI file.

Manage device settings alla pagina 2727 | Configure temporary devices alla pagina 2731 | Bulk install
Bot Agent on devices alla pagina 1053

Efficiently map input and output variables between parent and child bots (Service Cloud
case ID: 00537090, 00698697)
For input variables, use the Quick map option to select the variables and set the values for
the parent bot to pass. For output variables, use the Multiple variables tab to associate each
dictionary key with a variable. This feature eliminates the need to use actions to extract the output
dictionary values.
Task Bot package alla pagina 1895 | Using the Run action alla pagina 1896
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Nuove funzionalità

Support for PowerBuilder application in App Integration package (Service Cloud case ID:
00680703)
The App Integration package now supports PowerBuilder to capture and extract text from a window
application. The Capture text of window action enables you to open a PowerBuilder screen to
capture all the data and verify the captured text.

Enhancements to check-out option in the private workspace
• The My bots page in the private workspace displays a new status Checked out edited for

bots that are checked out and edited.
• Use the Revert edits option to cancel any changes you made to the checked-out bot in the

private workspace.

Programmatically delete bots, files, and folders
Use the Delete files/folders API to delete objects from the private or public workspace.
DELETE <control_room_URL>/v2/repository/files/{id}

Manage scheduled bots using APIs
Use the Bot Scheduler APIs to create, update, and view details, and delete bot schedules.
Bots can be scheduled to run at a specific date and time on an unattended Bot Runner, or on a
recurring basis.

Nuova action nel package Terminal Emulator
Use the Search Field action in the Terminal Emulator package to search for a field based on the
text it contains. This action returns the name or index of the field based on the option selected.
Terminal Emulator package alla pagina 1902

Nuova action nel package PDF
Use the Get Property action in the PDF package to retrieve the properties of a PDF file and
assigns the properties to a dictionary variable.
Using the Get property action alla pagina 1738

Nuova actions nel package Browser
Use the following actions in the Browser package:
• Close: Closes a Google Chrome browser window or tab.
• Get source code: Recupera il codice sorgente di una pagina web e lo salva in una variabile di

stringa.
• Go back: Consente di tornare a una pagina web visitata in precedenza nella scheda corrente.
• Open: Opens the browser to a specific web page in an existing tab, new tab, or window.
• Run JavaScript: Executes JavaScript in a web page.

Browser package alla pagina 1425
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Nuove funzionalità

Specify application window dimensions
Use the Resize windows option to set the window height and width to specific dimensions or
to the dimensions at which it was captured. This feature enhances the bot's ability to identify the
target object.
I seguenti packages supportano questa funzionalità:
• App Integration
• If Image recognition condition
• If Legacy Automation > Window Control condition
• Image Recognition
• Simulate keystrokes
• Legacy Automation Desktop > Manage windows controls action
• Loop While > Image recognition condition
• Loop While > Legacy Automation > Window Control condition
• Mouse
• OCR
• Screen

Support for function keys in Terminal Emulator package
Function keys (F1 through F24) are now supported to automate processes using ANSI and VT100
terminals in the Terminal Emulator package.

Use regex case insensitive flag for Window title
Enable the regex Case insensitive flag to identify a Window title field as not case-sensitive. This
feature enables you to successfully run the bots even if the letter case does not match the captured
window title.
The following packages and actions support this feature:
• Wait
• Image Recognition
• Simulate keystrokes
• Mouse > Click action
• Legacy Automation Desktop > Manage windows controls
• OCR > Capture window, Capture area
• Screen > Capture window, Capture area
• Recorder > Capture
• Window: Activate, Close, Maximize, Minimize, Resize

Unattended Bot Runner supported on Citrix devices
You can now deploy bots on unattended Bot Runners on virtual machines on Citrix XenDesktop and
Citrix VDI Windows 2016.

Funzionalità modificate

Only Bot Scanner related files and folders are deleted
The Bot Scanner now deletes only Bot Scanner related files and folders from the destination folder.
Scan Enterprise 11 or 10 bots using Bot Scanner alla pagina 1160
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Funzionalità modificate

Enhanced transport layer security (Service Cloud case ID: 00677546, 00681830)
The default Elasticsearch ports (47599, 47600) now use the more secure TLS version 1.2 and later
as the communication channel between the Control Room and Elasticsearch server.

Enhanced Update node action in XML package (Service Cloud case ID: 00663089)
When you edit and save an XML node, the bot updates the required attributes and their values in
an alphabetical order, without removing any existing attributes of the node.
For example, consider two existing attributes in an XML node such as Name=Peter and
Phone=9829xxxxxx. If you change the value of the phone attribute as 9887xxxxxx and add a
new attribute Gender with value as Male, the bot updates the phone value and adds the gender
as a new attribute, without removing the existing name attribute.

Interface change in Excel basic and Excel advanced packages
The session name field is now the last field in actions in the Excel basic and Excel advanced
packages.

Access at subfolder level in Control Room repository (Service Cloud case ID: 00634847,
00681221, 00685654)
An administrator can now allow access at the subfolder level in the Control Room by assigning the
Run, Check-in and Check-out permissions to the subfolder. You can only access the contents of
the subfolder and not the other bots or files in the parent folder.

Increased working area in the Bot editor
More horizontal and vertical screen area is available in the Bot editor for developing bots. You can
hide or display the Actions and Details panels to maximize the working area in the Bot editor.

The following table lists the fixed features and the builds in which they were fixed (Build 7560 is the latest
build, and Build 7554 is the previous build). The fixes are cumulatively available in the latest build.

Problemi risolti

Numero di build ID caso Service Cloud Descrizione

7560 00696614 Bot deployment is no longer delayed after you
insert Work Items if idle devices are available
for the deployment in queues.

7560 00703339 The post Work Item insertion flow is now
improved so that bot deployments are not
delayed.

7560 00706042, 00706074,
00706201, 00706195,
00706134, 00706022,
00707033

An issue with Control Room login page not
supporting SAML for SSO and reporting an
errant IPD response has been addressed. The
SSO function of the Control Room login works
as expected.

7554 00659336 Enterprise 11 bots that use the Image
Recognition command or Image Recognition
condition of the If command now run
successfully after migration.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

7554 00647634 The Bot Scanner no longer becomes
unresponsive when scanning a large repository.

7554 00678614 An error is no longer encountered when
you migrate a bot with a credential name
that contains a space character or a special
character.

7554 00669247 An error is no longer encountered when you
download a file from a URL that contains a
Unicode character using the Download files
action of the Browser package.

7554 00685916 If you have used the Date system variable
as an input variable in a MetaBot, the
Date system variable is now available after
migration.

7554 00674594 The Bot Scanner no longer encounters an
error when scanning a bot that uses the
Excel Column system variable after the Loop
command and the column name specified in
that variable contains a space character.

7554 00691905 An error is no longer encountered when you
edit a user after migrating to Enterprise A2019
from Version 11.3.3.

7554 00691072 An error is no longer encountered because
of the bypass configuration of proxy settings
when you use the Bot Migration Wizard.

7554 00689910 You can now import more than 2100 bot files
without any SQL exception error.

7554 00669927 When you execute the Bot Insight Business
Data and Operations Data APIs, only
information limited to the logged-in tenant is
now retrieved in the API response.

7554 00639779 After you log in to the Control Room and
connect manually to a VPN, the Bot Agent now
reconnects automatically. You do not have to
restart the Bot Agent service to reconnect.

7554 00622075 When you run a bot on a user device that has
an extended display, the runtime window is
now completely visible on the main display.
Previously, the window was partially visible
between the main and extended display.

7554 00678454 In Excel advanced, you can now use the Set
cell action to write more than 4100 characters
in the excel file. Previously, the bot execution
failed when the cell value had more than 4100
characters.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

7554 00675333 In the Number package, the field in the
Assign action is now corrected as Select the
source number variable/ value. Previously,
the Select the source string variable/
value field was incorrect.

7554 00674315, 00677925,
00684201

When you create a TaskBot using the If and
Else if actions and change the placement of
the Else if block action, there is improved
visibility in the Flow view. Previously, the
TaskBot was not displayed properly on a
low contrast display when the Else if block
placement was changed.

7554 00662072, 00674336 In the Terminal Emulator package, you
can now correctly page up using the
KEY_PGUP function key and page down using
KEY_PGDOWN for the TN5250 terminal type.

7554 00658261 The PDF Extract image action now supports
CMYK (cyan, magenta, yellow, black) images
format when you extract and save a CMYK
image to an RGB (red, green, and blue) image.
Previously, if PDF files contained CMYK images,
the bot could not extract them and displayed
an error.

7554 00675749 When you receive emails using the EWS server
option, the emailCc and emailTo variables
now return the proper value. Previously, these
variables returned blank values.

7554 00663610 In the Ftp/Sftp package, you can now connect
to ftp.box.com and use the Get folder
action. Previously, the Get folder action
downloaded files in the folder, causing the bot
to run in an infinite loop.

7554 00675710 In the Data Table package, the Remove
duplicate rows action now removes all
duplicate rows rather than a single duplicate
row.

7554 00539762 In the For value action of the Prompt
package, characters are no longer visible
during keystrokes of masked values.

7554 00679370, 00673085,
00674546, 00676912,
00678852, 00678796,
00692420, 00695390

An unknown error is no longer encountered
when you run the Open Excel file action from
a network drive.

7554 00672719, 00673048 Audit log entries in the Control Room are
now retained even if the Elasticsearch data
is configured to a file path other than C:\ (C
drive) during installation.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

7554 -- You can now insert Work Items from one
queue to another queue for workload
automation.

7554 -- You no longer have to pause and resume
queues because Work Items are now
processed and not randomly skipped when you
use the priority queuing or round-robin method
for workload automation.

7554 -- The Recorder package no longer takes time to
upload to a remote application repository path
of an On-Premises Control Room deployed on
Microsoft Azure.

7554 00683744 You can now capture objects from the Google
Chrome browser using the Recorder capture
action. The plug-in not installed or disabled
error is no longer displayed.

7554 00672446, 00671782,
00671065, 00683870

When you upgrade to this release from
an earlier release (for example, Enterprise
A2019.16), the Elasticsearch OpenDistro error
message is no longer displayed. Also, the
previous application_log indices from
Elasticsearch are deleted to free up disk space
for the upgrade.

7554 00690003 You can now use the Terminal Emulator
package without any change in the screen
resolution for the mainframe terminal type
TN3270. Previously, the screen resolution was
not supported for terminal type TN3270.

7554 00679244 In Dictionary and List packages, you can now
use the Datetime data type in the source
dictionary variable field of the Assign action.
Previously, an error was encountered during
bot execution if you used Datetime data type
in the source dictionary variable field.

7554 00673591 Fixed an issue in the Task Bot package where
the system selected all the input variable
options when the user clicked away from and
returned to the action.

7554 00684905, 00703481 A TaskBot now runs as scheduled and no
longer shows the device status as Picked
at runtime on the View task in progress
(Activity) page when the TaskBot is running.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

7554 00573081 The audit log page in the Control Room now
records all entries related to bot deployment.
Also, when a parent task with many child bots
is deployed, the audit log now shows correct
entries. Previously, some audit log entries were
missing for bot deployment and if a parent task
with many child bots was deployed, the entries
displayed were incorrect.

Limitazioni note

Enterprise A2019 does not yet support the counter behavior of the $Excel Cell Row$
system variable in Enterprise 11 when the variable is used in the Loop command and
the Each row in Excel Dataset option is selected. This behavior is available in 11.3.0
and earlier versions by default, and in the Version 11.3.1.2 and later versions when the
retainexcelcellrowlegacybehavior tag in the AASettings.xml file is set to true.

A bot fails when it runs an action that reloads the web page, such as the Recorder > Capture
action when it is used to click a link or the Browser > Open action, followed by a Browser >
Run JavaScript or Browser > Extract source action.
You must add a delay of at least 5 seconds to give the browser time to load.

A bot fails when it runs the Browser > Close action to close the last Google Chrome window and
the window contains only one tab.
Use the Tab or All browsers options instead.

A bot can return only a maximum of 3 MB to an output variable.
Soluzione: Store the bot output on the device, such as in a .txt file. If the output must be shared
across multiple Bot Runners, store the output in a shared drive.

The AISense Recorder fails if you manually upgrade the Recorder package version, such as by
importing a bot that contains a Recorder package version from a more recent build than the
destination Control Room. Always upgrade the Recorder package through the Control Room.

If you install the Google Chrome extension in the Microsoft Edge browser, it causes recording and
runtime errors in bots that interact with the Google Chrome browser. Even if you did not manually
install the Google Chrome extension, the auto-sync settings in the Microsoft Edge browser might
have automatically installed the extension.
If the Google Chrome extension is installed in the Microsoft Edge browser, you must remove the
Google Chrome extension from the edge://extensions page.

When the regex Case insensitive flag is enabled for actions that include the window title, a
recapture of the application window fails.

The input parameters for DLLs are not automatically passed from the parent bot to the child bot in
Enterprise A2019 for migrated MetaBots.
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Limitazioni note

Workload automation limitation for manual Credential Vault mode (Service Cloud case ID:
00711410)
You might face issues when migrating your workload automation if the Control Room is configured
to use a manual mode for Credential Vault.
Soluzione: As the Control Room administrator, perform the following steps:
1. Change the Credential Vault mode to express from manual in the Control Room database

configuration table.
2. Add the credential vault key to the CredentialVault.dat file in the Control Room server

repository.
3. Restart the Automation Anywhere Control Room Service.
4. Re-register the Bot Agent or restart the Bot Agent service.

Cloud migration limitations
• The Cloud migration utility keeps running in background if you close the utility when the

Enterprise 11 data is being uploaded.
• If you have configured Enterprise 11 Control Room in cluster mode, you must stop the

Automation Anywhere Control Room Service on all the nodes available in the cluster.
• If the Cloud migration utility is installed on a different device than the device on which the

Enterprise 11 Control Room you want to migrate is installed, an Elasticsearch unavailable error
occurs.

• If you have SSO configured on the Enterprise 11 Control Room, an error is encountered after
migration to Cloud if you change the authentication from database to SSO.

• If you provide the validation code within double quotation marks, the utility successfully
validates the code but fails when uploading the Enterprise 11 data.

If you open a table variable for editing and then open another table variable and click Cancel in
the Edit table window, the schema of that table reverts to the same schema of the first table. This
occurs only in the interface; it does not impact the bot.
Soluzione: Refresh the window containing the Control Room.

If you use different versions of a package in a parent bot and a child bot, the capability to share a
session across bots is currently not supported in the following packages: DLL, Excel advanced, Excel
basic, and Terminal Emulator
To share a session across parent and child bots, ensure that you use the same version of the
package in both the parent and child bots.

Automation Anywhere Robotic Interface (AARI)

Nuove funzionalità

New AARI on the web package
Use the AARI on the web package to perform actions such as assign, query, and cancel tasks;
create and query requests; and retrieve a list of team members.
AARI Web package alla pagina 1369
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Nuove funzionalità

Filter by time
You can now filter your requests and tasks by time:
• Requests tab: Use the Created and Updated options in the Filter window to select any

dates.
• Tasks tab: Use the Task created and Task updated options in the Filter window to select

any dates.

Filter and search for a request alla pagina 2168 | Filtrare e cercare un'attività alla pagina 2170

View updated dates
• Use the new Updated column in the Requests tab to view the dates and time of a request

that was last updated.
• Use the new Task Updated column in the Tasks tab to view the date and time of a task that

was last updated.

Variable options
In the Insert a variable window, the Variable field now shows child elements of available
references, which include Dictionary, List, Record, and Table variable types.

Delete a request
AARI administrators, managers, and users can now delete requests created by the AARI process.
The AARI administrator can delete any requests. AARI managers can delete requests of the team
for which they are the owner. AARI users can delete only the requests they have created.
Delete a request alla pagina 2164

Automatically assign managers and users
Users can now select the Auto assign this task option in the Human Task to assign managers
or users to the task. Users can also select the Auto assign the target task to option in the Go
to element to assign managers to the task.
Crea un processo AARI alla pagina 2133

Enhancements to elements in the form builder
• Time element: Includes the time element in a form.

Using the Time element alla pagina 2202
• Date element: Set the date format of the user machine as the default format for the date

element in the form.
Using the Date element alla pagina 2191

• Select file element: Drag the selected file into the form during bot runtime.
Using the Select File element alla pagina 2193

• Password element: View the password you enter in this field during bot runtime.
Using the Password element alla pagina 2197
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Nuove funzionalità

Updates to interactive forms
• Use the Change Form Title to edit or change the title of the selected form during bot runtime.
• Use the Validate form option now for the Table element.

Interactive forms package alla pagina 1638

Funzionalità modificate

Process package renamed to AARI on the web package
The Process package is now renamed to the AARI on the web package, which includes the Create
a Request action and additional new actions.
AARI web package

Enhancement to process management page
In the process management page, the AARI admin can now edit the Process Title and Process
Description metadata. You can now add a title and provide a short description for the process.

Enhancement to the activity page
All the Bot Runner (attended or unattended) trigger deployments in queue are now displayed in the
Activity > In progress page.
Attività alla pagina 2611

Edit check box, radio button, and drop-down form elements in process editor
In the process editor, you can now edit and update the List of options and Default value fields
for the following form elements: Checkbox, Radio button, and Dropdown.

Problemi risolti

ID caso Service Cloud Descrizione

00678572 You can now view the strict-transport-
security header when using the AARI on the
web interface. This attribute informs the web
browser to automatically convert websites
requesting HTTP to load HTTPS instead in
order to comply with the HTTP Strict-Transport-
Security (HSTS) policy.

-- The Display message field in the If/Else
pair action now displays the status message in
request view. Previously, the status message was
not displayed in the request view.

-- When you access AARI through the web
interface, the Request ID and Task ID now
correctly identify the data as numeric data type
and sort it accordingly. Previously, the data was
considered as string type and the sorting was
not appropriate.
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Problemi risolti

ID caso Service Cloud Descrizione

00646148 A bot is no longer deployed multiple times when
the files and folders triggers are used.

Limitazioni note

When a user with a Citizen Developer license deletes an event trigger, this activity is not captured in
the Audit log tab.

When you delete a request from the Request tab, the tasks associated with the request are not
deleted and they are displayed in the Tasks tab.

If you click the refresh option in the Tasks tab and navigate away and back to the tab, the task
filter applied does not remain the same. The filter always switches to Pending status.

Discovery Bot

Nuove funzionalità

Use Model option for system-generated views
You can now use the Model option to compare and find the best aggregated view for your
recordings. Use this option to save as many views with different combinations as required.
You can also save the view as a manual view to further customize your view and compare side-by-
side. Select either an Easy or Strict model so that you can view recordings where the steps are
the same versus recordings with different results with more branches in the process path.
Create a process view with branches and opportunities

Use Filter option for system-generated views
You can now use the Filter option to use a set of values to compare different sections of a process
across various recordings by selecting a specific path and step filter. Used along with the Model
option, the path and step filter options for a system-generated or manual view can help you to
determine and decide on a good candidate for automation.
Create a process view with branches and opportunities

Use toggle frequency counter option for system-generated views
You can now use the toggle frequency counter to display the number of recordings that a particular
path takes in the flow in a system-generated view. Use this option to help you understand the
frequency of the path compared to other recordings or views.
Create a process view with branches and opportunities

Remove recording screenshot for data privacy
Use the Screen option (icon) to display or hide the recording screenshot before submitting the
recording for the analyst to review. Use this option when you do not want to share personal image
details with the analyst.
Registrare un processo aziendale Discovery Bot alla pagina 2348
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Nuove funzionalità

Download PDD from the Opportunities table
You can now download a process definition document (PDD) for an opportunity directly from the
Opportunities table listed on the Opportunities page. The PDD is automatically generated when
the opportunity is created. After the PDD is generated, the field changes from generating PDD to
Download PDD. You can then download and save the document.
Review opportunities and convert to

Funzionalità modificate

Screenshot image is increased
The screenshot image is now increased to allow for better readability of captured steps. You can
now use the scroll wheel to get a zoomed-in view of the step.

The Export to Word option now supports 2000 steps.

The Convert to Bot option now supports 2000 steps.

Problemi risolti

ID caso Service Cloud Descrizione

-- The Delete icon is now properly visible in the
edit recordings screen in Internet Explorer.

-- You can now change the zoom level in any
canvas using the two-finger swipe on the
trackpad of the Aggregated and Comparison
tabs.

-- The red highlight is now visible on the captured
screenshots from the Recordings page and
from the preview pane from the Aggregated
and Opportunity tabs for analyst review.

Limitazioni note

When upgrading to this release, you must regenerate all PDDs created in Enterprise A2019.17. Click
Retry PDD Generation to regenerate the PDDs.

If you want to display an image that you have hidden and saved, you must first click the Screen
icon and then click Save to display the image again.

In the Opportunities table, the search field and filter drop-down option are not available for the
Process and Owner columns.

When an opportunity is created for a system-generated view with filters applied, the filter is
reapplied on the view displayed within the Aggregated tab from the Opportunities page. The filter
incorrectly displays No recording data. The Convert to Bot and the Download PDD options
are not affected.

When a recording is canceled, the recording is incorrectly incremented and displayed on the
process tile in Process Cycle.
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Limitazioni note

You cannot approve a recording with more than 500 steps.

IQ Bot

Nuove funzionalità

New IQ Bot Extraction package
On-Premises e Cloud
IQ Bot now includes the IQ Bot Extraction package for processing invoices. The package uses Bot
Runners on your local device instead of an IQ Bot server for processing.
IQ Bot Extraction package alla pagina 1654

Funzionalità modificate

Miglioramento a Utilità migrazione
Quando esporti un file (.iqba) di archivio IQ Bot, viene esportato solo un singolo documento
associato a ogni formazione (gruppo) bot disponibile.

Miglioramenti al IQ Bot Classifier package
The IQ Bot Classifier package now supports all languages supported by ABBYY FineReader Engine.
Previously, only English language was supported.
ABBYY FineReader Engine OCR supported languages

Problemi risolti

ID caso Service Cloud Descrizione

00668625 When you upload documents containing digital
signatures to learning instances, the Designer
now displays the correct success or error
message.

00619139, 00695157 When you now run a bot and try to edit it while
it is still running, the following correct message
is displayed: Staging Documents for this
Vision bot is in progress. Please
try after some time. In precedenza,
veniva visualizzato il seguente messaggio errato:
Learning instance not found.

00408482 Ora puoi esportare correttamente un dominio
personalizzato creato utilizzando il coreano o
altre lingue asiatiche.

00669197, 00681599 Node.js is now upgraded to version v10.22.1 to
fix a security vulnerability.
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Problemi risolti

ID caso Service Cloud Descrizione

-- Fixed an issue that caused the following error:
failed to upgrade DB -1. You can now
install IQ Bot in express mode without any
errors.

00633197 During validation, if there is an error in the
validation pattern, the validation process now
fails, the correct message is displayed, and error
logs are generated.

00689326 You can now view the extraction results correctly
even when the bot is trained with check box
fields.

00666456 I servizi di apprendimento automatico IQ Bot
vengono ora installati correttamente al momento
dell'installazione di IQ Bot.

Limitazioni note

IQ Bot On-Premises e Cloud
The following limitations apply to the IQ Bot Extractionpackage:
• If you process documents that do not belong to any created groups, they are not displayed in

the Details page of the learning instance.
• The Checkbox extraction option is not supported.
• Some of the input invoices are not processed when you set up workload management with

shared input and output folders.
• Pre-processing settings from IQ Bot server are not applied.

IQ Bot On-Premises e Cloud
When creating learning instances, IQ Bot sometimes does not restrict users from creating duplicate
fields.

IQ Bot On-Premises e Cloud
Occasionally IQ Bot fails to execute Python logic for tables other than the default one.
Soluzione: Retry after you perform one of the following actions:
• Fai clic su Salva e chiudi.
• Click See Extraction results.

IQ Bot On-Premises e Cloud
In PDF documents containing multiple pages, at times the segments do not display correctly on all
pages.
Soluzione: Use PDFBox OCR to process the documents.
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Limitazioni note

IQ Bot On-Premises e Cloud
For the Get page content action of the IQ Bot Pre-processor package, if you select the Create
variable option from the List of strings extracted from page menu, you can only use Any
from the Subtype drop-down menu.

IQ Bot Community Edition, On-Premises and Cloud
If you use Internet Explorer version 11.0.973.17763 to log in to IQ Bot and open See extraction
results for a learning instance, you cannot open or download the Preview.csv file.

IQ Bot On-Premises
You must be a service account user to install IQ Bot on a fresh machine.

IQ Bot On-Premisesand Cloud
The auto-correction and auto-suggestion features, which are part of the MLScheduler service, use
system resources extensively and cause the system to slow down or stop responding.

Bot Insight

Nuove funzionalità

Access Bot Insight data from Tableau
Use the Tableau connector in Bot Insight to access business and operational information. The
Tableau connector connects to the Bot Insight APIs to create various business and operational
metrics that you can analyze and visualize within Tableau.
Configure Tableau web data connector in Bot Insight alla pagina 2983

Assign Bot Insight license (Service Cloud case ID: 00651973)
Assign the Bot Insight license to users to enable them to view and perform tasks on the Business
dashboard. You can now assign the license on a per-user basis, irrespective of the assigned roles.
Licenze Automation 360 alla pagina 1010

Problemi risolti

ID caso Service Cloud Descrizione

00689802 You no longer encounter an issue when you
create and view default dashboards in a
development (dev) environment. Previously, an
error was displayed when you open the bot and
clicked Analyze to create the default dashboard.

Pacchetti supportati

Pacchetto Versione

Application 2.1.0-20201112-22332
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Pacchetto Versione

App Integration 2.3.0-20201210-171315

Active Directory 2.1.0-20201112-223323

Boolean 2.1.0-20201126-165109

Browser 2.3.0-20201211-222811

Clipboard 2.1.0-20201126-165124

Comment 2.3.0-20201126-165125

CSV/TXT 2.3.0-20201126-165126

Database 2.2.0-20201112-223343

Data Table 2.5.0-20201201-130615

Datetime 2.2.0-20201126-165136

Delay 2.2.0-20201126-165137

Dictionary 3.2.0-20201126-165138

Run DLL 3.3.0-20201126-165850

Email 3.2.0-20201120-062604

Error handler 2.3.0-20201126-165148

Excel basic 2.4.0-20201126-165604

Excel advanced 5.3.0-20201208-090251

File 3.2.0-20201126-165151

Folder 3.1.0-20201126-165154

FTP / SFTP 2.2.0-20201115-072759

Image Recognition 2.2.0-20201117-081754

JavaScript 2.4.0-20201126-165412

Simulate keystrokes 2.5.0-20201112-223902

Legacy Automation 3.2.0-20201124-064544
1.5.0-20201125-004358

List 2.2.0-20201126-165427

Log To File 2.2.0-20201126-165428

Loop 2.1.0-20201126-165429

Message Box 2.1.0-20201126-165430

Mouse 2.2.0-20201112-223917

Number 2.1.0-20201126-165444

OCR 2.3.0-20201126-081210

Office 365 Excel 2.2.0-20201104-062559

Office 365 Calendar 2.1.0-20201111-162101
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Pacchetto Versione

Office 365 OneDrive 2.2.0-20201126-165550

PDF 2.6.0-20201126-165555

PGP 2.2.0-20201126-165557

Ping 2.1.0-20201126-165559

Play Sound 2.1.0-20201127-115706

Prompt 2.2.0-20201109-192507

Python Script 2.4.0-20201208-064944

Recorder 2,10-20201215-211402

REST Web Service 3.2.0-20201112-224735

SAP 2.2.0-20201126-165852

Screen 2.2.0-20201126-165855

SNMP 2.1.0-20201126-165859

SOAP Web Service 3.2.0-20201123-093411

String 3.1.0-20201126-165909

System 3.0.0-20200921-090225

Terminal Emulator 3.6.0-20201213-084139

VBScript 2.4.0-20201208-065526

Wait 3.1.0-20201126-165922

Window 2.3.0-20201123-093430

Workload 2.1.0-20200825-071644

XML 2.1.0-20201126-165927

Riferimenti correlati
Note sulla versione Community Edition A2019.18 alla pagina 695

Note su Enterprise Edition A2019.17
Data di rilascio:2 dicembre 2020

Review the new features, changed features, fixed features, security fixes, known limitations, and supported
packages in the Enterprise A2019.17 (Build 7103) release. IQ Bot è nella Build 7082.
• Enterprise A2019
• AARI
• Discovery Bot
• IQ Bot
• Bot Insight alla pagina 514
• Supported packages
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Funzionalità di migrazione

Importante:  Migration to Enterprise A2019 (currently available only to customers in the
Migration Early Adopter Program)
Migration to Enterprise A2019 is currently only available to select customers through our Migration Early
Adopter Program. If you are interested in learning more about this program or a timeline for when
migration will be available to all customers, contact your Automation Anywhere representative.

The following features apply to both Enterprise 11 and Enterprise 10:

Obtain information about upcoming support
for commands and variables

Bot Scanner provides information about the
upcoming Enterprise A2019 release in which a
specific command or variable will be supported or
available.

Migrate MetaBots with screens Migrare MetaBots che contengono schermi come
asset. You can migrate screens based on the Java
technology and captured using the Object, Image,
and Coordinate play modes.
Come viene eseguita la migrazione di MetaBots alla
pagina 1223

View progress of bot migration A progress bar is displayed in the migration results
tab when the system starts migrating the bots.

Migrate bots that use SAP command You can migrate Enterprise 11 bots that use the
GUI Automation command to capture various
objects from an SAP application.
Mappatura dei pacchetti per la migrazione alla pagina
1247

Migrate bots that use the following
attributes:

• Regular expression to search for files on which
you want to perform an operation.

• Variable to specify the child bot you want to run.
• System variables to retrieve information about a

device's settings and its performance.
• The Save header To option and containing

array and dictionary variables in the REST Web
Service command to store the response header.

• Bots that contain failure responses from the
REST Web Service command by using the
Capture failure response option in Enterprise
A2019. For Enterprise 11 bots, this option is
enabled by default.
REST Web Service package alla pagina 1777

• Variables with names containing Arabic or
Russian characters, or Japanese double-byte
numbers.
Unicode range supported in variables alla pagina
2036
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The following features apply to Enterprise 11 only:

Increment loop counter value by 1 The $Counter$ variable used in loop in Enterprise
11 bots is replaced with the $Condition-Counter
$ variable in the migrated bots and value for the
variable set to 1.
Service Cloud case ID: 00659314

View audit log migration reports View the status of audit log migration and other
related information in the All migrations page.
View additional information by using the View
migration option for each audit migration instance.
Esegui la migrazione dei log di audit Enterprise 11 alla
pagina 1196 | Visualizza i rapporti di migrazione alla
pagina 1299

Migrate Enterprise 11 Bot Insight data and
dashboards

• Migrate Enterprise 11 Bot Insight data and
published dashboards of bots enabled for
analytics by using the Bot Insight pre-migration
utility and Bot Migration Wizard.
Esportazione di dashboard Enterprise 11 Bot Insight
per la migrazione alla pagina 1194 | Migrazione
dei bots di Enterprise alla pagina 1216

• View Bot Insight migration reports from
the new Bot Insight results tab on the
Administration > Migration > View
migration page.
Visualizza i rapporti di migrazione alla pagina
1299

Migrate bots that use the following
attributes:

• MetaBots with DLLs that use credential variables
of string, character, or byte data type.

• The Launch website action of the Browser
package to open a website in the Microsoft Edge
browser.

• Shared session to establish a connection with
a terminal server or open a Microsoft Excel
spreadsheet and close the shared session from
the child bot.

• IBM 5555 B01 and C01 models for TN5250
terminal types and the Default terminal for the
VT100 terminal type.

Enterprise A2019

Importante:  This release includes a required update to your . Ensure that you complete the update to
continue with your automation activities when upgrading from a previous release to this release.
Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina
1043
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To verify which  version is compatible with this release, see Compatibility with release builds alla pagina
1026.

Nuove funzionalità

Connect to EWS server with OAuth authentication
A new authentication is available for the Exchange Web Services (EWS) protocol with OAuth.
You can use the OAuth authentication and enable your EWS-managed API applications to access
Exchange online in Office 365.
Using Connect action for Email alla pagina 1497

Google Cloud Platform supported for On-Premises deployment
You can now host the Control Room, and create and deploy automation on devices configured to
use the Google Cloud Platform environment.
Sistema operativo, ambiente e piattaforma supportati per la Control Room alla pagina 850

LDAP channel binding for enhanced network security in On-Premises deployment
Control Room supports LDAP channel binding in order to comply with a security release from
Microsoft. LDAP channel binding provides enhanced security for network communications between
an Active Directory and its clients. It provides a more secure LDAP authentication over SSL and TLS.
Configure LDAP channel binding alla pagina 984

Use Bot Agent with AWS WorkSpaces (Service Cloud case ID: 00652474, 00676112)
You can now deploy bots on Bot Agent devices that are configured on AWS WorkSpaces.
Compatibilità di Bot Agent alla pagina 1025

VT220 terminal type supported in Terminal Emulator
To establish a connection and communicate with another machine, you can now use the VT220
terminal for sending and receiving text.
Using Connect action for Terminal Emulator alla pagina 1903

Permission to cancel checkout in Control Room
Use the Cancel checkout permission to cancel checked-out TaskBots or files from the public or
private workspace.
• In the public workspace, the status of the bot changes to public.
• In the private workspace, the status of the bot changes to new if any changes were made to the

bot. Se non ci sono modifiche, il bot viene sostituito con un clone.

Check out a single bot alla pagina 2000
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Nuove funzionalità

Miglioramenti al Recorder
• Record a task using the Universal Recorder or AISense Recorder from a single point of entry.

Both recorders are now managed through a single package, which enables faster and more
efficient updates.

• You can now record tasks in a Microsoft Edge browser that runs on Chromium (versions 79 and
later).

• Use the AISense Recorder Define option to capture an object that is only visible when you
hover the mouse over the object.

• Use the Resize window option in the Recorder > Capture action to set the window width
and height.
This option delivers a more reliable bot. It resizes the window to the dimensions at which the
task was recorded, thus increasing the likelihood that the bot identifies the target object.

Get started with recorders alla pagina 1948 | Universal Recorder supported applications and browsers alla
pagina 1958 | Utilizzo dell'action Acquisisci alla pagina 1763

Use shared session in Terminal Emulator
Use the new Shared session option to pass the exact state of an application to a concurrently
occurring TaskBot or MetaBot logic. For example, instead of connecting to the same application
multiple times for different tasks, you can use the option to connect to the application using a
single task, thus optimizing your automation logic in the long run.
Share session between TaskBot logic alla pagina 1914

Share an Excel session between bots
Use the Set session action from the Excel basic or Excel advanced package to assign an Excel
session to a variable, and then pass that variable from a parent to a child bot. This enables the
child bot to access the worksheet opened in the parent bot.
Excel basic package alla pagina 1527 | Excel advanced workbook operations | Example of sharing an
Excel session between bots alla pagina 1899

New option for Run Task
In the Task Bot package, you can now use the Run action with an option to repeat the selected
task until you choose to stop it.

New search for roles in User Management API
Use the new Search for roles API in the User Management APIs in Swagger to obtain a list of
all the roles or details for a specific role.

Capture response status of REST API
In the REST Web Service package, you can capture the response status of the REST API in the
dictionary variable. The dictionary variable now shows the response key with its value.

New option for REST Web Service (Service Cloud case ID: 00489741, 00646436)
Use the Capture failure response action in the REST Web Service package to capture response
details in the response body.
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Nuove funzionalità

Use regular expressions in packages
You can use regular expressions (regex) in certain actions to support pattern-based search in a file,
folder, or Windows title. Regular expressions are supported in the actions of the File and File and
Folder packages such as Copy, Delete, Rename, Print Multiple files, and Zip.
You can also use regular expressions in some packages that support the wildcard character in their
window titles.
The following packages and actions support regular expressions:
• Wait
• Image Recognition
• Simulate keystrokes
• Mouse > Click action
• Legacy Automation > Manage windows control
• OCR
• Screen
• Recorder > Capture
• Run DLL > Run function (Legacy), Run function
• Window: Activate, Close, Maximize, Minimize, Resize

Using Copy Desktop file action for file alla pagina 1563 | Utilizzo dell'action Acquisisci alla pagina 1763

Support for overloaded functions in DLL package
The DLL > Run function action can now handle .dll files that contain multiple functions of the
same name. The action calls the function based on the number of parameters passed.
Utilizzo dell'action Esegui funzione alla pagina 1488

New actions for SAP captured objects
Use new actions that are available for Tree, Tab, and Label controls to perform operations for the
various objects captured from an SAP application.
Recorder actions supported in various SAP versions alla pagina 1772
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Nuove funzionalità

Enhancements to elements in the form builder
• Image element: Upload image files to the form using this element.

Using the Image element alla pagina 2195
• Button element: Validate all the fields in a form using the Validate all form fields when this

button is clicked option.
Utilizzo dell'elemento Pulsante alla pagina 2190

• Password element: Use one of the following formatting options:
• Standard: set the character limit and choose additional security options.
• Custom: add a custom password on the Regular expression page.

Using the Password element alla pagina 2197
• Rich Text Editor element: Use this element in the Set action when creating a bot in order to

add or overwrite the value of a variable.
• Table element: Includes the following updates:

• New data types for Column settings:
• Data
• Numero
• Elenco a discesa

• The following actions, which you can use during bot runtime:
• Set action to add rows to the table.
• Trigger events to add rows and delete rows.
• Sort table columns.

• Text Box element: Choose one of the following formatting options:
• Standard: set the character limit for this field.
• Custom: add a custom password on the Regular expression page.

Using the Text Box element alla pagina 2201
• Select file or Snapshot element: When you click Preview during bot runtime, the system

default application is used to display the selected file.
Using the Select File element alla pagina 2193 | Using the Snapshot element alla pagina 2199

Enhancement to List view of bots
In the List view of the Bot editor, you now drag a selected action to the task logic.
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Nuove funzionalità

Import Enterprise 11 bots to Enterprise A2019 (Service Cloud case ID: 00512847)
• Bot Lifecycle Management Import feature: The Bot Lifecycle Management import feature

enables you to import Enterprise 11 bots from multiple Enterprise 11 Control Room instances to
a single Enterprise A2019 instance by using the aapkg file.
Bot Lifecycle Management alla pagina 2832 | Importa bots alla pagina 2837

• Bot Lifecycle Management Import API: You can also use this API to import Enterprise 11
bots to the Enterprise A2019 instance by uploading the aapkg file. However, you can import a
password-protected aapkg package only by using the Import API.
BLM API  | see Import repository bots in BLM API

New endpoint in License API
Use the List details of Control Room licenses endpoint to retrieve metadata including the
license type, number of available licenses, number of licenses used in a specific Control Room
instance, and number of licenses used in all Control Room instances.
License API

Programmatically manage device login credentials
Use the Login setting endpoint of the Credential Vault API to set or update the device login
credentials to allow bots to run on the device.

Store multiple lines of text in a string variable
You can use a string variable containing multiple lines of text in the following actions:
• String > Assign
• String > Extract text
• String > Compare
• String > Lowercase
• String > Replace
• String > Reverse
• Log to file
• Message box
• The string condition in the If, Wait, and While actions

Arabic, Japanese, and Russian characters supported in variable names
You can now create variables with names containing Arabic or Russian characters, or Japanese
double-byte numbers.
Unicode range supported in variables alla pagina 2036
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Funzionalità modificate

Configure granular security for Bot Agent (Service Cloud case ID: 00653807)
Starting from this release, only registered Bot Agent device IP addresses that are added in the
Allowed IP addresses list of the Network Settings can connect to the Control Room. In
previous releases, devices from all subnets and IP addresses within the corporate network were
allowed to connect to the Control Room URL.
Add access IP addresses alla pagina 2735

Update to Excel advanced package
The Open action in the Excel advanced package now opens a Microsoft Excel spreadsheet even
when a file extension is not provided.

Disable clone and view content permissions for check-in (Service Cloud case ID: 00656157)
When the Check in permission is selected, the Clone and View content permissions are also
automatically selected. As a Control Room administrator, you can now disable the Clone and View
content permissions when required.

Associate triggers with unattended Bot Runners
Ensure that the default device is not in locked state if you are associating triggers with unattended
Bot Runners.

Additional license support enhancements
Control Room administrators are enabled to install a new GUID license before an existing license
expires.

Change in edit device permission
Starting from this release, the permission to edit devices is not available in the system-created
AAE_Basic role by default in the Control Room. A user has to select the Edit the device(s)
permission separately.
Dispositivi alla pagina 2628

The following table lists the fixed features and the builds in which they were fixed (Build 7103 is the latest
build, and Build 7096 is the previous build). The fixes are cumulatively available in the latest build.

Problemi risolti

Numero di build ID caso Service Cloud Descrizione

7103 00684905, 00703481 A TaskBot now runs as scheduled
and no longer shows the device
status as Picked at runtime on the
View task in progress (Activity)
page when the TaskBot is running.

7103 00676476 An error is no longer encountered
when you run a child bot that
contains a Japanese full-width space
character in the name.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

7103 00689935, 00689381,
00690368, 00690217,
0069053

License server syncing error
generated when control room
licenses and licenses stored on a
server are updated on different
schedules. This issue has been fixed.
Should an error message appear,
click "Sync licenses from Server" for
any new licenses in production to
manually sync the licenses.

7096 00667396, 00670001,
00653771, 00671553

Bot Scanner no longer encounters
an error when scanning bots with
non-ASCII characters in their name.

7096 00659334 The Offset from match option in
the Image Recognition package now
works correctly in migrated bots.

7096 00669166 You can now migrate large bots (for
example, with 30+ dependencies
and 500+ lines) using the Bot
migration package. The system no
longer encounters an error when
migrating a bot that contains a
large number of nested IF/ELSE
commands.

7096 00659349 You can now migrate bots with
special characters in their names.

7096 00670985, 00674145 The system no longer encounters an
error due to Bot Store credentials
when you migrate from Version
11.3.3 or a later version to
Enterprise A2019.

7096 00679817 An unknown error is no longer
displayed when you are migrating
a bot that the Bot Scanner listed as
ready for migration.

7096 00457898, 00488494 You can now register a device with
a username that contains non-ASCII
characters such as Korean language
characters.

Nota:  Before upgrading the Bot
Agent to the current version,
ensure that the registered device
is configured to use non-ASCII
characters.

Configuring post-installation settings
alla pagina 966

© 2023 Automation Anywhere. All rights reserved.     498



    Automation Anywhere - Learn

Problemi risolti

Numero di build ID caso Service Cloud Descrizione

7096 00611887 You can now download an exported
bot package using the Internet
Explorer browser by opening the
download link received in the email.
You can also do this from the
Activity > Historical page.

7096 00647932 When you create a bot using the
Get method action in the REST
Web Service package, the UTF-8
character set is now supported.
Therefore, Korean characters are
processed correctly in the REST
API response. Previously, UTF-8
characters were not supported.

7096 00641126 You can now use the Get single
cell action in the Excel basic
package to extract the date correctly
for the Japanese date format.
Previously, the Japanese date was
displayed in double quotation marks.

7096 00634102 You can now use the Simulate
keystrokes package with the Alt+F4
key and set a longer delay value
between each keystroke. Previously,
the bots displayed an error when a
longer delay value was set with the
Alt+F4 key.

7096 00655739 In REST Web Service, the Rest API
Get call now works properly even
when the encoded URL string has
special characters such as double
quotation marks. Previously, the
Rest API Get call failed when the
URL string had double quotation
marks.

7096 00653944 The String package now shows
the correct output when you use
the loop action to read a file name
that does not have an extension.
Previously, when the file did not
have any extension, the filename
extracted using the loop displayed
an incorrect output.

7096 00677941 When an optional field (Mark field
required is not selected) is now left
blank, a form is validated without
any error messages during bot
runtime.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

7096 00662011 When using the files and folders
trigger, you can now use any
available network drive to start a
bot.

7096 00666441, 00673888 For a folder trigger, you can now
select a folder name containing a
space character and the bot runs
successfully without encountering
any issues.
For example, you can select a folder
called 'Sales chart'.

7096 00622100 When Simulate keystrokes is
enabled for a hot key trigger, you
can now start a bot multiple times
using the associated hot keys
without encountering any issues.

7096 -- If an element is marked as Read-
only on the form builder screen,
a validation error is no longer
displayed for that field during bot
runtime.

7096 00570660 You can now use Windows forms
with the Run function action of the
DLL package.

7096 00624644 The system no longer encounters
an error when you upgrade from an
earlier version of Enterprise A2019
to a later version when the settings
are preserved and the installation
path is not the default location.

7096 00670008 You can now pause or resume a task
from the Activity > In progress
page.

7096 00667210, 00672875 In the Excel advanced package, you
can now use the Go to cell action
even if the Excel sheet does not
have any data or an active cell is out
of the worksheet range. Previously,
an issue was encountered when
you used the Go to cell action and
chose the cell option as Active cell
with the Beginning of the row,
End of the row, Beginning of the
column, or End of the column
option.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

7096 00659098, 00669437 You can now edit the Start date of
an existing schedule to today's date,
provided the start time is set before
the bot is scheduled to run.

7096 00671392 You can now stop a bot that is in
progress using the Stop option from
the In progress (Activity) page
or the Stop option on the runtime
window that appears when the bot
is being executed.

7096 00647761 You can now define a list variable of
subdata type Boolean or datetime
within an action. Previously, the
bot encountered an error in this
scenario.

7096 00671478 Fixed an issue in the Task Bot >
Run action where the value of an
input variable disappeared when the
user clicked Save. This issue only
occurred when the Current Task
Bot option was selected.

7096 00663719, 00635437 Fixed an issue where the OCR
package was missing from Control
Room instances hosted on Microsoft
Azure. The connection with the
Microsoft Azure database timed out
before the OCR package .jar file
could complete the upload.

7096 00631133, 00636174 In the Wait package, the Wait for
condition action in the recorder
object no longer waits indefinitely
during bot execution. If the required
window or its control does not
exist, the bot waits for the required
window or its control for the time
specified in the Wait for control
field. If the required window or
its control is not found within this
specified time, the bot continues to
perform the next set of actions.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

7096 00628863 Bot files or dependencies are no
longer lost when you check in or
check out a bot from the private
or public workspace when the
Elasticsearch service is running
and not in index read-only mode.
Previously, an error occurred when
a bot was either checked in or
checked out, and the bot files or
dependencies were lost and could
not be recovered.

7096 00673520 When a bot is deployed through RDP
with a predefined screen resolution,
the RDP resolution settings are
now applied correctly during bot
execution. Previously, the bot was
executed with an interchanged
resolution (the height and width
pixels were interchanged).

7096 00670346 After you edit a bot schedule, the
input value of a variable in the bot
no longer has to be reinitialized and
the bot does not show the default
output value for the variable when it
is executed.

7096 00653056,
00651853, 00647949,
00657465,00670024

The In progress activity is now
displayed correctly for bots deployed
on Bot Runners by any user.

7096 -- When developing custom packages,
you can now set your name in the
vendor column. To set the name,
update the author property of
the build.gradle file, as shown
below:

packageJson{
artifactName =
 project.name
group = "$groupName"
author = "<entername>"
 }

Leaving the field empty shows the
vendor name as unspecified.

7096 -- Multiple users can now
simultaneously run a bot associated
with a form without encountering
any issues on the same Bot Runner
machine.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

7096 -- You can now migrate Enterprise
11 bots that contain variables
that are in a different letter case
(uppercase or lowercase) than those
in Enterprise A2019. Variables are
case-sensitive in Enterprise A2019
but not in Enterprise 11, which
previously resulted in an error.

7096 00592758 You can now create a variable with
a name that starts with a numerical
character.

7096 00670994 You can now register with the
Control Room from a multiple-
user device configured for Active
Directory users.

7096 00677479 The deployment time of a priority
queue no longer takes a long time
(for example, more than 1 hour)
to process Work Items required for
workload automation.

7096 00667110 You no longer have to restart the
Automation Anywhere Bot Agent
service to resume queued Work
Items that are stuck in in-progress
state.

7096 00673043 When you specify a value in the
numOfRunAsUsersToUse parameter
of the Bot Deploy API, the
weighted system algorithm now
assigns tasks to the Bot Runners
with the least number of tasks
queued and currently running.
Previously, the algorithm did not
correctly calculate the weight of
queued and running tasks, which
resulted in an inefficient task
allocation to the same one or two
Bot Runners.

Limitazioni note

When a bot opens a website inside a loop, the Recorder Capture action fails after the execution of
Launch Website.
Soluzione: Add a delay of a few seconds in the loop between the Launch Website and Recorder
Capture action.

The Recorder Capture action does not support object recapture for the AISense technology type.
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Limitazioni note

The system does not display a value for a session variable when the variable is selected as
Watched variables in Debug mode.

The session variable returns a blank value when it is used as output in a bot and the bot is
deployed using the Bot Deploy API.

After an upgrade to the latest version of Enterprise A2019, the bot might encounter an error if you
are using the Close action of the Window package version 2.1.0-20200813-181240 or earlier.
Soluzione: Add a delay of 50 milliseconds after the Close action in the bot.

The Recorder package takes a long time (for example, approximately 6 hours) to upload to a
remote application repository path of an On-Premises Control Room deployed on Microsoft Azure.
Soluzione:
1. Before you install or upgrade to this version, configure the repository path in a local directory

of the Control Room node to upload the package.
2. After installing or upgrading, verify that all packages are available in the Packages page of the

Control Room.
3. Change the repository path to a remote file share.

The AISense Recorder fails if you manually upgrade the Recorder package version, such as by
importing a bot that contains a Recorder package version from a more recent build than the
destination Control Room. Always upgrade the Recorder package through the Control Room.

Automation Anywhere Robotic Interface (AARI)

Nuove funzionalità

Run a process in private workspace
You can now run a process in your private workspace by using the Run option in the process editor.
The bots in the process are then executed on the default device of the Bot Creator.
Configura i processi alla pagina 2121

Use the Data Privacy tag field
The Data Privacy tag enables users to generate hidden custom output in their process tasks
(Start panel, Human Task, and Bot Task). Users can enter the variables for this field during
runtime with values. In the web portal, the AARI admin can use this tag to check for requests or
tasks by using personal user data. The admin can also filter using this field.
Crea un processo AARI alla pagina 2133 | Filter and search for a request alla pagina 2168 | Filtrare e
cercare un'attività alla pagina 2170

Use variables types
You can now use new variables in the process editor such as createdOn and updatedOn
(DateTime), id (Number), and title (String). These variables are part of a data flow (workflow
engine) that moves data between each step of a process and requires variable input for the process
to run properly.
AARI variable types alla pagina 2141
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Nuove funzionalità

View previous selected tasks
AARI users can now reference selected actions of their tasks. When they view a submitted task in
request view, a check mark indicator is now displayed next to the buttons that are selected.

Funzionalità modificate

Configure scheduler user to allocate device pool to AARI on the web interface
In the AARI Settings page, the AARI administrator can now configure a scheduler user to allocate
the Control Room resources (devices and unattended Bot Runners) to AARI on the web interface.
The scheduler user must have View my bots and Run my bots permissions and have access
to a device pool and Bot Runners. The AARI process can then use those resources for each bot
deployment.
Configure scheduler user for AARI on the web alla pagina 2118

End point display
In the Completed panel, the End point has a new display option Update request title that
enables the user to update the request title. When the user updates the Display message field,
the update is now reflected in request view.
Crea un processo AARI alla pagina 2133

Use F2 to insert variables
You can now use the F2 keyboard shortcut to insert variables in the process editor.

Problemi risolti

ID caso Service Cloud Descrizione

-- The Task display name option in the Start
panel is now set to Request Creation by
default. Any name changes by the user is now
reflected in the request view.

-- The Feed data into form table in the process
editor now works properly and users can now
edit the field.

-- In a form that contains a Number field set to a
10-character limit, when you enter the maximum
character limit (for example, 1234567890) in the
number field in request view, the number values
are now accepted.

-- When you create a process with a form that
contains a Date element, the Condition option
in the If/Else pair action now allows you to
enter a variable. Previously, the option did not
allow you to enter a variable.
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Limitazioni note

In the process editor, if a bot contains an incorrect input variable, the properties panel highlights
the wrong element: Browse in the Select Task Bot field is highlighted instead of the incorrect
variable.
Soluzione: Hover your mouse over the red icon next to the Bot Task in the process editor to see
the error.

In the process editor, if you replace the Go to option with an End Process, the End Process icon
does not display the status (Completed, Failed, Canceled) correctly.
Soluzione: Click the End Process icon and change the status.

A Bot Task cannot pass data to the next task (Human Task or Bot Task) if it contains Japanese
characters in its output variable name.
Soluzione: Use English characters for the variable name in the Bot Task.

If a scheduler user has multiple sets of configurations (device pools and Bot Runners), due to a
mismatch in the selection of the device pool and the Bot Runners, the bot deployment fails.
Soluzione: Set Bot Runners in the Run As section of the consumer role. Ensure the scheduler
user has access to only one device pool and one consumer role that has run-as users.

When you access AARI through the web interface, the Request ID and Task ID consider the data
as string type instead of numeric data type and sorts it accordingly.
For example, if a Request ID or Task ID starts from 1 through 30, the IDs are sorted as string
data type (1, 10, 11, 12, 13, …, 2, 22, 23, …, 30) instead of numeric data type (1, 2, 3, 4, …, 30).

In some bot development failure scenarios, for example, files are not found or the scheduler user
does not have access to the bot file, bot development fails by timing out after one hour instead of
displaying an error.

If an AARI manager creates a team with the same name as a team created by any other manager,
no error message is displayed and two teams are created with the same name.

When you access AARI through the web interface, the task and case list pages do not display the
following words in the localized languages:
• Cerca attività
• Risultati
• Titolo richiesta

In the process editor page, the following words are not displayed in the localized languages:
• Voce processo
• Esegui
• Annulla
• Ripeti
• Tag privacy dei dati
• Auto assign this task to
• InitialData
• Aggiorna titolo della richiesta (facoltativo)
• Aggiorna nome attività (facoltativo)
• Boolean condition
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Discovery Bot

Nuove funzionalità

Column headers updated in Recordings page
The Recordings page now displays labeled column headers when you review captured steps for
recordings. The following headers are displayed for the associated text field:
• Screenshot
• Applicazione
• Dati
• Descrizione passaggio

Registrare un processo aziendale Discovery Bot alla pagina 2348

Highlight where you click or enter data when recording processes
The system now displays the area, component, or control where you click or enter data with a red
highlighted box at the time of recording.

Nota:  The red highlight is only shown in the captured screenshot in the generated bot. The
highlight is not shown on captured screenshots from the Recordings page for review and
after submission to the analyst. The highlight is also not shown from the preview pane from the
Aggregated and Opportunity tabs for the analyst review.

Supported applications and browsers for Discovery Bot alla pagina 2347

Condition and value displayed for each branch in Aggregated view
For the System generated view, the condition and its value for each branch are automatically
retrieved and displayed as part of the auto-generated Aggregated view.

System-generated aggregation
You can now merge multiple recordings into a single aggregated view automatically by selecting the
required set of recordings.
Create a process view with branches and opportunities

Convert system-generated aggregated view to a manual view
You can now convert a system-generated aggregated view to a manual view using the Save as
[manual] option or the Convert to Manual option from the Views table. This option enables
you to add more recordings or steps from other recordings to your process view.
Create a process view with branches and opportunities

Create an opportunity, including all steps and branches
You can now use the Select all steps option to create an opportunity that includes all steps,
branches, and sub-branches.
Create a process view with branches and opportunities
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Nuove funzionalità

Download a process definition document (PDD) (previously, Export to Word)
The Export to Word option is now renamed as Download Process Definition Document
(PDD). Quando viene creata un'opportunità, il PDD inizia automaticamente l'elaborazione in
background. When the PDD is ready for download from the Control Room, an email notification is
sent to the email address on file to the opportunity owner.

Nota:  You must be the owner of the opportunity to be able to download the PDD.

Review opportunities and convert to

Receive email notification when your bot is converted successfully
You can now receive an email notification when your bot is successfully converted. Click the
hyperlink in the email to take you to your folder in which the bot was generated.
Review opportunities and convert to

Funzionalità modificate

Zoomed-in view of captured steps is increased
The zoomed-in view in the Screenshot field is now increased from x4 to x8 for better readability of
captured steps.

Permissions layout
The layout of the permissions for Discovery Bot is now changed to separate the individual and “all”
permissions to easily manage access control.

Problemi risolti

ID caso Service Cloud Descrizione

-- When you create a branch in a view, typically
a single step from the current branch is moved
into the left branch while a new branch with an
empty box is added to the right branch. You can
add steps from a different recording only into
the empty box in the right branch. Typically, only
one step from the original branch is included in
the left branch. If the branch is created following
the last step in the flow, then no steps will be
included in the left branch. You can now add
new steps to the left branch in case it was the
last step. You can also move the endpoint of
the newly created branch lower or higher in the
process to include additional steps in the left
branch.

Limitazioni note

In the Opportunities tab, the process and owner column does not allow you to sort in ascending
or descending order, or when you sort for both process and owner.
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Limitazioni note

In the Opportunities tab, the search field and the filter drop-down option do not work when you
search for the Process or Owner columns.

The Download PDD option is disabled if you are not the owner of the opportunity.

The Delete icon is not properly visible in the edit recordings screen in Internet Explorer.
Two-finger swipe on the track pad does not change the zoom level in any canvas of the
Aggregated and Comparison tabs.

Discovery Bot is currently not supported on Linux.

The red highlight is only shown in the captured screenshot in the generated bot. The red highlight
is not shown on captured screenshots from the Recordings page for review and after submission
to the analyst. The highlight is also not shown from the preview pane from the Aggregated and
Opportunity tabs for analyst review.

IQ Bot

Nuove funzionalità

Support for Arabic language
When creating a learning instance, you can now choose the Arabic language from the Primary
language of documents drop-down menu, with the following limitations:
• Advance table extraction is not available.
• Search field on the Validator is not supported.
• Arabic numerals are not supported.

For example, if the document has date or time in Arabic language, it is extracted as text and
validations can fail.

Nota:  You can still use string-based validation checks (such as regular expressions) for Arabic
numerals.

• Arabic is only supported on ABBYY FineReader Engine 12.4.

Creating a learning instance

Default validations for a group
When editing a learning instance, you can now use the Select the default validations group
drop-down menu to select an available group. This allows all the new group documents in
production to be extracted based on the custom logic and validations defined in this selected group,
before it goes to the Validator.
Edit a learning instance
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Funzionalità modificate

Automatically detect check box
IQ Bot can now automatically detect check boxes and radio buttons in a document. You can enable
this feature when creating a learning instance.
Creating a learning instance

• With this feature enabled, during training, if you select check box from the data type drop-
down list and then you select the field value, only the check box segments are displayed.

• This feature does not work with the PDFBox option enabled.
Disable PDFBox option

Tegaki API OCR improvements
IQ Bot now uses enhanced Tegaki API OCR segmentation to improve accuracy in the following
scenarios:
• Multiple fields are merged into a single SIR
• Segmentation on empty spaces
• Overlapping SIRs
• Incorrectly located SIRs
• Partial or incorrectly captured values from SIRs

IQ Bot Tegaki API OCR engine

Updated versions of RabbitMQ v3.8.18 and Erlang/OTP
The IQ Bot installation package now includes RabbitMQ v3.8.18 version 3.8.8 and Erlang/OTP
version 23.0.4.
RabbitMQ and Erlang/OTP upgrade

PyArabic removed from Python installation
PyArabic is one of the Python libraries that was used in content extraction for Arabic language (right
to left). Because Arabic language is now supported by default with IQ Bot installation, PyArabic is
removed from Python installation.
List of Pandas Libraries which are supported and not supported on Automation 360 IQ Bot (A-People login
required)

Nota:  Ensure you update any bot that you have deployed using PyArabic.

Performance improvement (Service Cloud case ID: 00629302)
IQ Bot now takes significantly less time to create a bot for groups containing only production
documents.
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Problemi risolti

ID caso Service Cloud Descrizione

00500914 The TesseractLog.log file is now available in the
following directory: C:\Users\Public\Public
 Documents\Automation Anywhere IQBot
 Platform\Logs\Engine\.
The log level is set to error by default.
You can change this setting in the
CognitiveServiceConfiguration.json file.

00430923, 00618234, 00636422,
00478986, 00414921

All uploaded documents are now rendered correctly,
irrespective of their content orientation while uploading,
which enables you to train them without encountering
any issues. Previously, when you created a learning
instance, documents that did not have the correct content
orientation (they were upside down or tilted) could not be
trained.

00653929 IQ Bot On-Premises: With segmentation improvements,
you can now train documents in the Korean language
using the Tegaki API OCR engine without any system-
identified region (SIR) errors.

-- The system no longer creates any unnecessary folders for
successfully classified documents that are uploaded using
the IQ Bot [Local Device] package.

-- You can now use the designer page when creating a
learning instance to test all the documents, without any
error messages.

00590165 For a learning instance, you can now use the See
extraction results option to browse all the documents in
the selected group.

00672470 After validating the fields of production documents, you
can now use the Save current document option to save
all the validated document, without any error messages.

-- Check box fields are now extracted with better accuracy.
You can use the Checkbox auto-detection feature so
that IQ Bot automatically detects the check box fields and
radio buttons.

00652269, 00619139 When you now run a bot and try to edit it while it is still
running, the following correct message is displayed:
Staging Documents for this Vision bot is
in progress. Please try after some time.
In precedenza, veniva visualizzato il seguente messaggio
errato: Learning instance not found.

00601401 When creating a learning instance, you can now use
the Thai language for form and field names without
encountering any issues.

00624416 When you migrate a learning instance, group descriptions
are now migrated without any errors.
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Problemi risolti

ID caso Service Cloud Descrizione

-- If you select any field on the Validator screen, the focus
from that field is no longer lost when you now click or
draw to select SIR.

00662968 Sometimes, when you click See Extraction Results
and the preview fails, IQ Bot now correctly displays
the following error message after a timeout of 2
minutes: Error occurred while extracting the
document. Please re-check the training/
document. Previously, when the preview failed, the page
kept loading indefinitely.

00674110 Production documents are now moved to the Validator
without any errors, irrespective of how the bot was trained
(number pages, number of segments in each page, or
number of tables and fields extracted).

Limitazioni note

IQ Bot On-Premises e Cloud
In the table area of the Validator, if you add a new row, enter a value, and then delete this row, the
value of the next row is replaced by the content you entered in the deleted row.

IQ Bot On-Premises e Cloud
In the Validator, when you click any validated field and then click any other cell, the value in the
validated field is deleted.

IQ Bot On-Premises e Cloud
When you upload a document to production immediately after deleting a bot it was associated with,
extraction results are not displayed.
Soluzione: Use one of the following options:
• Select the Disable cache option in the Network tab.
• Ensure you wait at least 3 minutes between deleting the bot and uploading the document.
• Empty the cache and reload the page.

IQ Bot On-Premises e Cloud
You cannot use Express mode to install IQ Bot.

IQ Bot On-Premises e Cloud
Numerals in the Polish language are not accepted or validated in the Validator.

IQ Bot On-Premises e Cloud
If you create a user role with 2-byte non-English characters, services fail with an invalid
characters message.

IQ Bot On-Premises e Cloud
If the name of a learning instance has both English and Arabic characters, the time stamp of the
backup file is appended in between the filename.
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Limitazioni note

IQ Bot On-Premises e Cloud
You cannot use the draw functionality to generate an SIR when you zoom in on a document in the
Validator.

IQ Bot On-Premises
After installing IQ Bot, MLWeb services stops responding.
Soluzione: Manually stop and restart the MLWeb services.

IQ Bot On-Premises
If you add a new language after upgrading to IQ Bot A2019, the Learning Instance page is not
displayed due to Language API cache issues.
Soluzione: Clear the cache and restart the IQ Bot service.

IQ Bot On-Premises e Cloud
Se tenti di elaborare un documento PDF con pdfboxOCR abilitato, i SIR non vengono posizionati
correttamente nelle caselle di controllo.
Soluzione: Disable the pdfbox OCR when you create a learning instance.

IQ Bot On-Premises e Cloud
If you create a learning instance with Auto Checkbox Detection enabled, check box SIRs cannot
be selected.
Soluzione: Disegna sopra la casella di controllo SIR invece di selezionare il campo SIR identificato.

IQ Bot On-Premises e Cloud
Starting with IQ Bot A2019.17, the default OCR engine is changed to ABBYY FineReader Engine
12.4 from the previous 12.2 version. Therefore, if you have migrated learning instances from earlier
versions, you might have to retrain your bots because there could be a change in segmentation.

IQ Bot On-Premises e Cloud
The Default validations group is not overwritten on the imported learning instance even when
the Overwrite option is used when you import that learning instance.
Soluzione: Edit the learning instance after importing the IQBA file and change the default group.

IQ Bot On-Premises e Cloud
A learning instance is exported as an IQBA file that contains Projectdetails.csv. When you
extract this .csv file, the column header name for the Default validations group in the table is
not available. However, the corresponding value in that column is available.

IQ Bot On-Premises e Cloud
If you re-import an IQBA file for a deleted learning instance, the Default validations group
setting available in that IQBA file is not applied to the learning instance.
Soluzione: Edit the learning instance after importing the IQBA file and change the default group.
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Bot Insight

Nuove funzionalità

New AARI dashboard in Bot Insight
Use the AARI dashboard to view various widgets that provide information about requests created
from published processes in AARI. The dashboard also provides statistics on the status of created
requests.
AARI dashboard alla pagina 2965

Correzioni per la sicurezza

ID caso Service Cloud Descrizione

-- The Allow Header HTTP header is removed
from Bot Insight.

Pacchetti supportati

Pacchetto Versione

Application 2.1.0-20200921-085720

App Integration 1.1.0-20201014-042506

Analizza 2.2.4-20200903-113949

Active Directory 2.1.0-20200921-085716

Boolean 2.1.0-20201014-042509

Migrazione bot 2.5.0-20200902-045043

Browser 2.1.0-20201002-123733

Clipboard 2.1.0-20201014-042520

Comment 2.2.0-20201014-042520

CSV/TXT 2.3.0-20201014-082525

Database 2.2.0-20201013-052941

Data Table 2.3.0-20201030-143334

Datetime 2.2.0-20201014-042531

Delay 2.2.0-20201014-042532

Dictionary 3.2.0-20201014-042532

Run DLL 3.2.0-20201105-205159

Email 3.1.0-20201104-062204

Error handler 2.2.0-20201014-042541

Excel basic 2.3.0-20201027-160012

© 2023 Automation Anywhere. All rights reserved.     514



    Automation Anywhere - Learn

Pacchetto Versione

Excel advanced 5.1.0-20201027-155758

File 3.1.0-20201016-065515

File & folders 1.1.0-20201023-202725

Folder 3.0.0-20201016-065517

FTP / SFTP 2.1.0-20200921-085757

IF/ELSE 2.1.0-20200921-085758

Image Recognition 2.1.0-20201014-042552

Moduli interattivi 2.17.3-20201102-103733

IQ Bot 2.1.0-20201013-095304

JavaScript 2.3.0-20201104-062431

Simulate keystrokes 2.4.0-20201021-163833

Legacy Automation 3.2.0-20201104-062439
1.3.0-20201105-151906

List 2.2.0-20201014-042806

Log To File 2.2.0-20201014-042806

Loop 2.1.0-20201014-042808

Message Box 2.1.0-20201014-042808

Migrazione 2.7.0-20201106-072418

Mouse 2.1.0-20201014-042814

Number 2.1.0-20201014-042823

OCR 2.2.0-20201104-062503

Office 365 Excel 2.2.0-20201104-062559

Office 365 Calendar 2.1.0-20200921-085726

Office 365 OneDrive 2.1.0-20201014-042924

PDF 2.5.0-20201014-042929

PGP 2.2.0-20201014-042931

Ping 2.1.0-20201014-042932

Stampante 2.1.0-20200921-090131

Play Sound 2.1.0-20200921-090123

Prompt 2.1.0-20200918-081201

Python Script 2.3.0-20201105-204912

Recorder 2.0.9-20201105-164103

REST Web Service 3.1.0-20200928-231420

SAP 2.2.0-20200921-090209
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Pacchetto Versione

Screen 2.1.0-20201014-043037

SNMP 2.1.0-20201014-043041

Servizio 3.0.0-20200921-090214

SOAP Web Service 3.1.0-20200921-090219

String 3.1.0-20201014-043052

System 3.0.0-20200921-090225

Attività 2.0.1-20201023-202703

Terminal Emulator 3.4.0-20201028-021451

Trigger Email 1.1.0-20201105-152220

VBScript 2.3.0-20201105-205228

Wait 3.1.0-20201014-043117

Window 2.2.0-20201022-121649

Workload 2.3.0-20201105-205233

XML 2.1.0-20201014-043121

Riferimenti correlati
Note sulla versione Community Edition A2019.17 alla pagina 701

Note su Enterprise Edition A2019.16
Data di rilascio: 28 September 2020

Review the new features, supported packages, changed features, fixed features, security fixes, and known
limitations in the Enterprise A2019.16 (Build 6463) release. IQ Bot è nella Build 6443.

Importante:  We have updated Enterprise A2019.16 to Build 6463 to include fixes for issues with
checking in and checking out bots (Service Cloud case ID 00666880, 00670899, 00672441, 00670455,
00672346), and Universal Recorder (Service Cloud case ID 00664020). See the Fixed features section for
more information.

• Enterprise A2019 alla pagina 516
• Discovery Bot alla pagina 533
• IQ Bot alla pagina 536
• Bot Insight alla pagina 537
• Automation Anywhere Robotic Interface (AARI) alla pagina 538

Enterprise A2019

Nota:  Starting with this release, if you are installing the Control Room in Linux environment, ensure that
Python 3.6 is installed.
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Importante:  This release includes a required update to your . Ensure that you complete the update to
continue with your automation activities when upgrading from a previous release to this release.
Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina
1043

To verify which  version is compatible with this release, see Compatibility with release builds alla pagina
1026.

Nuove funzionalità

Migration to Enterprise A2019 (currently available only to customers in the Migration
Early Adopter Program)
Enterprise A2019
Migration to Enterprise A2019 is currently only available to select customers through our Migration
Early Adopter Program. If you are interested in learning more about this program or a timeline
for when migration will be available to all customers, contact your Automation Anywhere
representative.
• Enterprise 11 only

• Migrate audit logs to Enterprise A2019.
Esegui la migrazione dei log di audit Enterprise 11 alla pagina 1196

• Migrate bots that contain disabled commands that have validation errors.
• Migrate bots that contain Delete, Delete All Messages, and Get All Messages commands

to automate an email-related task on Exchange Web Services (EWS).

• Enterprise 10 only
Migrate user credentials to the Enterprise A2019 Credential Vault.
Come vengono copiati i dati di Enterprise 10 in Automation 360 alla pagina 1204

• Enterprise 11 e Enterprise 10
• Migrate bots that contain the Variable Operation command, which re-initializes the row

and column index of an array variable using a variable.
• Migrate bots that run MetaBot Logic and return the values to a dictionary variable.
• Migrate MetaBots that contain DLLs that use lists, values, arrays, and two-dimensional arrays

as input and output.
Come viene eseguita la migrazione di MetaBots alla pagina 1223

• Migrate bots that contain Send Email with Attach Variable option from the Error Handling
command to the Enterprise A2019 Error handler package.
Mappatura dei pacchetti per la migrazione alla pagina 1247

• Migrate bots that contain the Image and Coordinates play modes from the Object Cloning
command to the Recorder package in Enterprise A2019.
Mappatura dei pacchetti per la migrazione alla pagina 1247

• Migrate bots that contain credential variables in select commands such as Active Directory,
Excel, REST Web Service, and Terminal Emulator to Enterprise A2019.
For the complete list of commands, see Mappatura delle variabili per la migrazione alla pagina
1279.
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Nuove funzionalità

Support for using CSV and TXT files as databases
Enterprise A2019 and Community Edition
Use the actions from the Database package to connect with and perform create, read, and update
operations on the file.
Utilizzo dell'action Connetti per il database alla pagina 1451 | Database package alla pagina 1449

Universal Recorder support for standard Microsoft controls in Microsoft Silverlight
Enterprise A2019 and Community Edition
The Universal Recorder can now capture calendars, buttons, check boxes, combo boxes, date
pickers, labels, links, list views, radio buttons, sliders, tabs, tables, text boxes, and trees from
applications running Microsoft Silverlight version 5.

Use variable to specify a child bot to run
Enterprise A2019
Use the Control Room path in the Run action of the Task Bot package to use a string variable to
specify the child bot you want to run.
Task Bot package alla pagina 1895

Install Bot Agent in bulk using registration key (Service Cloud case ID: 00616591)
Enterprise A2019
As an Control Room administrator, you can generate a registration key from the Control Room
settings to install Bot Agent in bulk on multiple devices. You can use the registration key in an
installation script or as part of the Active Directory group policy for configuring the Control Room
users.
Generate registration key to install Bot Agent in bulk alla pagina 2764

Automatically detect proxy settings for Bot Agent installation to support NTLM
authentication (Service Cloud case ID: 00446932, 00639773)
Enterprise A2019 and Community Edition
The proxy settings for a Bot Agent are automatically detected if the Automatically detect
settings option is selected in the LAN settings for a System user and Current user on the
machine where the Bot Agent is installed. This allows Control Room users to be authenticated using
NTLM.

Restrict network access to Cloud Control Room URL
Enterprise A2019
System administrators can restrict access to the Cloud Control Room URL from only those IP
addresses within the corporate network for more granular security. The Automation Anywhere
Control Room provides the ability to specify a list of IP addresses or IP subnets that are allowed for
Cloud Control Room URL and API access. Enterprise A2019 users with Control Room administrator
privileges, such as to access Administration > Settings, can view, add, or edit this list.
Add access IP addresses alla pagina 2735
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Nuove funzionalità

Add Elasticsearch credentials for enhanced monitoring and alerting
Enterprise A2019
An option to provide Elasticsearch credentials is now available in the installer because the updated
Elasticsearch version 7.8 configured for Control Room uses Open Distro version 1.9.0. This feature
enables the server to deploy an enhanced monitoring and alerting system.
Add Elasticsearch credentials alla pagina 916

Support for Chinese, Japanese, and Korean characters in variable names
Enterprise A2019 and Community Edition
You can now create variables with names containing Chinese, Japanese, or Korean characters. You
can also migrate bots that contain variables named using these characters.
Unicode range supported in variables alla pagina 2036

Support for Chinese language for Terminal Emulator (Service Cloud case ID: 00500324)
Enterprise A2019
You can now use the simplified and traditional Chinese language with 5250E terminal DBCS models
such as IBM 5555-C01 and IBM 5555-B01.

New Services package available
Enterprise A2019 and Community Edition
Use the new Services package to automate operations and application services. You can start, stop,
pause, resume, or to get the status of a Windows or application service.
Service package alla pagina 1843

Enhancements to the Excel advanced package
Enterprise A2019 and Community Edition
In the Excel advanced package, you can now use Read value from a cell. You can choose the
Read option to read either visible text or the value from the cell. The default option is set to Read
visible text in cell.
For example, if the cell has $50 as the value, then the Read cell value option reads the value
as 50, ignoring the currency format. The Read visible text option reads the content along with
currency format as $50.
This option is available for the following actions:
• Ottieni cella singola
• Ottieni più celle
• Leggi riga
• Leggi colonna
• Get worksheet as datatable
• Loop

Cell operations in Excel advanced alla pagina 1551 | Row and column operations in Excel advanced alla
pagina 1548 | Loop package alla pagina 1681
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Nuove funzionalità

Automate a task on a range of cells in an Excel worksheet (Service Cloud case ID:
00651299)
Enterprise A2019 and Community Edition
In the Excel advanced package, you can perform operations on the range of cells for Go to cell
and Set Cell actions.
Cell operations in Excel advanced alla pagina 1551

New condition in the If and Loop packages
Enterprise A2019 and Community Edition
Use the Service is running or Service is not running condition to execute actions based on
whether a particular service is running or not. For example, when you send a mail using this
condition, the bot can verify if the SMTP service is running or not.
If package alla pagina 1625 | Loop package alla pagina 1681

Capture hidden objects using AISense Recorder
Enterprise A2019
Use AISense Recorder to capture hidden image buttons on the application screen.
Edit a task recorded using AISense alla pagina 1969

New operations on SAP captured objects
Enterprise A2019
Use new options that are available to perform operations such as Set Focus and Select item by
key for the various objects captured form an SAP application.

Pass parameters of various types to a DLL function
Enterprise A2019
Use the new Run function action to pass parameters of various types to a DLL function. The Run
function that was available in earlier versions is now renamed to Run function (Legacy) and
enables you to pass only dictionary variable as parameter to a DLL function.
Utilizzo dell'action Esegui funzione alla pagina 1488 | Using the Run function (Legacy) action alla pagina
1487

Form builder updates
Enterprise A2019
Il generatore di moduli ora include i seguenti nuovi elementi:
• Rich text editor- Enables you to add a customizable element to the form.
• Table- Enables you to add tables to a form.

Create a form alla pagina 2186

Enhancements to the form preview
Enterprise A2019
When you click the Preview option in the form builder screen, you can drag the form. The
corresponding X and Y coordinates are updated automatically.
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Nuove funzionalità

Enhancement to the Snapshot element
Enterprise A2019
You can now create a folder if the filepath is not available or change the destination folder of the
snapshot file during bot runtime.
Using the Snapshot element alla pagina 2199

Update to the Interactive forms package
Enterprise A2019
Use the Validate form action to validate all the elements of a selected form.
Interactive forms package alla pagina 1638

New permission to view basic information about users and roles (Service Cloud case ID:
00491694)
Enterprise A2019
The View Users and Roles basic information permission enables you to view the names of
users and roles when you are performing various tasks in the Control Room. For example, a user
must have this permission to view the roles that can be assigned to a user when creating or editing
that user. After you upgrade from an earlier version to this release, this permission is granted to all
existing roles.

Securely pass values in header and parameters of calls to a REST or SOAP web service
Enterprise A2019 and Community Edition
Credential variables enable users to retrieve sensitive values from the Credential Vault and pass
them to the web service. Use credential variables in the header or parameter fields of actions from
the REST Web Service or SOAP Web Service package.
Credentials and credential variables in the Bot editor alla pagina 2039 | REST Web Service package alla
pagina 1777 | SOAP Web Service package alla pagina 1880

Return system parameters of the device on which a bot is running
Enterprise A2019 and Community Edition
Use the Get environment variable action from the System package to return the system
parameters, including HomePath, ProgramData, ProgramFiles, SystemRoot, and UserDomain.
Get environment variable action alla pagina 1892

Remove Git integration configuration (Service Cloud case ID: 00633948)
Enterprise A2019
You can now remove or disable a Git integration configuration from your Control Room when the
bot information stored in your Control Room does not have to be synchronized with the remote Git
host.
Remove Git integration configuration alla pagina 2757

Expanded data type support in DLL package
Enterprise A2019 and Community Edition
The DLL package now accepts table variables as input parameters or to hold action output.
Using the Run function (Legacy) action alla pagina 1487

© 2023 Automation Anywhere. All rights reserved.     521



    Automation Anywhere - Learn

Nuove funzionalità

Create variable within Dictionary > Assign and List > Assign actions
Enterprise A2019 and Community Edition
The Assign action from the Dictionary and List packages now offers users the option to create a
new variable within the Select source variable field. Previously, users could only select a variable
from a list of existing variables.

New API for license management
Enterprise A2019
The License API contains endpoints to retrieve Control Room license details (such as the expiration
date and license mode) and to update the Control Room after license reallocation or renewals.
License API

New expression in the Legacy Automation package
Enterprise A2019
The List to table expression supports migrated bots containing a variable that has to be converted
from a list type to a table type.
Legacy Automation package alla pagina 1668

Multi-user device sessions on terminal servers
Enterprise A2019
Multi-user device sessions are now supported on terminal servers. Puoi effettuare le seguenti
operazioni:
• Set screen resolution at either the device or Control Room level.
• Set a multi-user device as the default device for Bot Creator users and attended and unattended

Bot Runner users.
• As a licensed user (with a default device), set another device as your default device using the

Make default device option from the device menu.
• View and edit the device settings on the device landing page.

The device landing page shows additional information about the user-provided device name
(device nickname), device type, and the default user.

• Convert an existing device to a multi-user device in order to share the same device between
Bot Runner and Bot Creator users who can then coexist in different sessions simultaneously. (ID
caso Service Cloud: 00624046)

About multi-user devices alla pagina 2631 | Convert an existing device to a multi-user device alla pagina
2634 | Configure RDP-based deployment for multi-user devices alla pagina 2632

Pacchetti supportati

Pacchetto Versione

Gestione nodi 14.1.7079

Application 2.1.0-20200819-064505

App Integration 1.1.0-20200825-070948

Analizza 2.2.4-20200903-113949
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Pacchetti supportati

Pacchetto Versione

Active Directory 2.1.0-20200825-070945

Boolean 2.1.0-20200831-031000

Migrazione bot 2.5.0-20200902-045043

Browser 2.1.0-20200825-071008

Clipboard 2.1.0-20200831-031014

Comment 2.1.0-20200831-031015

CSV/TXT 2.3.0-20200825-071131

Database 2.1.0-20200913-060112

Data Table 2.1.0-20200831-031946

Datetime 2.2.0-20200831-031025

Delay 2.2.0-20200831-031026

Dictionary 3.2.0-20200831-031027

Run DLL 3.0.0-20200831-110441

Email 3.0.0-20200901-105426

Error handler 2.1.0-20200831-031055

Excel basic 2.1.0-20200831-031843

Excel advanced 5.0.0-20200909-124042

File 2.2.0-20200831-031057

File & folders 1.1.0-20200907-073046

Folder 2.2.0-20200831-031100

FTP / SFTP 2.1.0-20200825-071155

IF/ELSE 2.1.0-20200825-071156

Image Recognition 2.1.0-20200825-071159

Moduli interattivi 2.16.0-20200914-151814

IQ Bot 2.1.0-20200901-105449

JavaScript 2.1.0-20200831-031525

Simulate keystrokes 2.3.0-20200901-093759

Legacy Automation 3.1.0-20200831-031532
1.1.0-20200825-071342

List 2.2.0-20200831-031539

Log To File 2.2.0-20200831-031539

Loop 2.1.0-20200831-031540

Message Box 2.1.0-20200831-031541
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Pacchetti supportati

Pacchetto Versione

Migrazione 2.5.0-20200902-045043

Mouse 2.1.0-20200831-031542

Number 2.1.0-20200831-031551

OCR 2.2.0-20200825-071359

Office 365 Excel 2.1.0-20200825-071452

Office 365 Calendar 2.1.0-20200825-071013

Office 365 OneDrive 2.1.0-20200825-071459

PDF 2.5.0-20200831-031836

PGP 2.2.0-20200831-031838

Ping 2.1.0-20200831-031839

Stampante 2.1.0-20200825-071516

Play Sound 2.1.0-20200825-071509

Prompt 2.1.0-20200824-092056

Python Script 2.1.0-20200831-031850

Recorder 2.0.8-20201009-015051

REST Web Service 3.1.0-20200824-092129

SAP 2.2.0-20200825-071614

Screen 2.1.0-20200825-071618

SNMP 2.1.0-20200825-071620

Servizio 3.0.0-20200821-060952

SOAP Web Service 3.1.0-20200827-210959

String 3.1.0-20200831-031943

System 3.0.0-20200831-031944

Attività 2.0.1-20200907-072949

Terminal Emulator 3.3.0-20200831-031950

Trigger Email 1.1.0-20200903-114514

VBScript 2.1.0-20200831-031953

Wait 3.1.0-20200831-031955

Window 2.1.0-20200813-181240

Workload 2.1.0-20200825-071644

XML 2.1.0-20200831-031958
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Funzionalità modificate

Enhanced Capture area action in OCR package
The Capture area action now captures text from the visible area of the screen even if the target
area is below the visible screen. Previously, the bot showed an error when the captured area was
below the visible screen.
Using Capture area action from OCR package alla pagina 1701

Bot Scanner update
The Bot Scanner now displays error messages for bots that cannot be migrated to Enterprise A2019
in the summary report.
Analisi del report di Bot Scanner per la migrazione alla pagina 1162

Flow view update
A line number is now displayed for each action in the Flow view of the Bot editor.

CSV/TXT package update
The CSV/TXT package processes a space as character. For example, if your CSV or text file includes
January, "March, April", then the output is displayed in the following format:
Gennaio
"March (space before the double quotation mark)
April"
If the CSV or text file contains the same information but without a space between January and
March (for example, January,"March, April"), then the output is displayed in the following
format:
Gennaio
March, April

Upgrade for resilient bot deployment
After you upgrade the Control Room and Bot Agent to Enterprise A2019.16, scheduled and queued
bots are not terminated. This is part of the resiliency improvements where the Control Room and
Bot Agent are set in a consistent state. As a result, the device reconnects to the Control Room if
there are any network disruptions, and scheduled and queued bots are deployed.

Importante:  During the upgrade to Enterprise A2019.16, all bots that are running will be
terminated. After the upgrade, if the system is in an inconsistent state, restart the Bot Agent so
that the system is in a consistent state.

Internet Explorer waits for completion before initiating Recorder action
When you use the Recorder package, the bot now waits for the Internet Explorer browser to finish
loading the page before executing any action. This enhances the reliability of the bot by preventing
it from failing while the page is loading. For example, the Recorder does not try to search the object
before the web page is fully loaded.
Utilizzo dell'action Acquisisci alla pagina 1763
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Funzionalità modificate

High availability enhancement
Starting from this release, configure the required minimum three Control Room nodes in an
Enterprise A2019 data center cluster for high availability deployment.
High availability deployment alla pagina 891

The following table lists the fixed features and the builds in which they were fixed (Build 6463 is the latest
build, and Build 6453, and Build 6448 are previous builds). The fixes are cumulatively available in the latest
build.

Problemi risolti

Numero di build ID caso Service Cloud Descrizione

6463 00644915 The Bot Agent now checks for additional
SSL certificate from the Windows
CERT_SYSTEM_STORE_LOCAL_MACHINE
system stores in addition to the Java Credential
Store. This allows the Bot Agent to be updated
automatically from an earlier release to this
release.

6463 00666880, 00670899,
00672441, 00670455,
00672346

Bot files or dependencies are no longer lost
when you check in or check out a bot from
the private or public workspace. Previously,
an error occurred while either checking in
or checking out a bot, and the bot files or
dependencies were lost and could not be
recovered.

6463 00664020 You can now successfully run a bot that
contains the Capture action from the Recorder
package with both the HTML InnerText and
InnerHTML object properties selected.

6463 -- Fixed an issue where the Universal Recorder
failed to perform a click, set text, or append
text action on the correct control in Google
Chrome when a debug window or download
bar was open.

6453 00669040, 00669164,
00668923, 669332,
00669473,00671509,
00669178

The Automation Anywhere Elastic Search
Service now restarts during the certificate
retrieval process when you upgrade from
Enterprise A2019.15 to Enterprise A2019.16.
However, if you encounter any issues with the
Automation Anywhere Elastic Search Service
during the restart, see Automation 360 v.16
upgrade error: Elasticsearch Service fail to start
during certificate retrieval process (A-People login
required).
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

6448 00573048 You can now preview table variables in debug
mode and validate the bot logic. Previously,
watch variables containing Japanese and
Chinese characters did not display values in the
table variable.

6448 00656475 The Bot Deploy API call now consecutively
executes all the runAs users that are set in the
runAsUserIds parameter.

6448 00569832, 00628474,
00656267

The device registration issue due to Bot Agent
version extraction is now fixed. The exception
of "for input string null" no longer
occurs.

6448 00609073 You can now successfully integrate your
Control Room with your remote Git repository
without any error. Previously, the Git
integration failed because of a 404 error.

6448 00632444, 00626829,
00667531

When you import a main task containing
subtasks using the overwrite option, the
dependent subtask references are no longer
deleted for other existing main tasks that use
the same subtasks. As a result, the execution
of other main tasks containing the same
dependent subtasks does not fail.

6448 00501208, 00572346 For the Create user event name, the audit
log now properly displays the username who
created that user in the Event Started By
column. Previously, the same column did not
display any value.

6448 00616202, 00637626,
00653919, 00664039,
00664744

When the debug log is enabled in logs
configuration and you use the For each row
in a SQL query dataset option from the
Loop action to iterate each row, the iteration
now completes without any error. Previously,
the iteration failed because of a change in the
debug log configuration.

6448 00653064 After the caching service is restarted, the bot
execution no longer fails. The caching client
instances are reconnected and reinitialized
after the restart.

6448 00577612 In a bot with dependencies, if you check out
and edit a child bot in your private workspace
and later check out the parent bot, you will no
longer lose the changes made to the checked-
out child bot. Previously, changes made to the
child bot were overwritten.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

6448 00623154 When a Bot Creator that does not have
create folder permission tries to check in a
bot to the public workspace, an appropriate
error message is now recorded in the audit
log, indicating the specific reason for the
failure. Previously, the audit log recorded an
unexpected error occurred message.

6448 00622977 In the Edit role page, file permissions are
now correctly aligned in Internet Explorer.
Previously, the Delete from Public option
was displayed below the Select all option. As
a result, the folder and permissions were not
placed next to each other.

6448 00615437 You can now migrate MetaBots that contain
input and output type variables with a
description containing unsupported characters
such as quotation marks (") and forward slash
(/).

6448 00636169 The Control Room now disables a user account
when the number of consecutive failed login
attempts specified in the Control Room settings
is reached or exceeded.

6448 00530550 A variable now returns the correct value when
the regional setting of the device is set to the
Brazilian metric system.

6448 00604893 A bot no longer encounters an error when the
system cannot finish pre-processing the bot
due to an ignite cache issue.

6448 00578277 An error is no longer encountered when the
Connect and Disconnect actions of the SAP
package are used in a loop and the iteration is
set to more than 500 times.

6448 00635890 The Bot Scanner now scans all the bots in a
repository and displays the correct count of
child bots.

6448 00634238 You can now use the form builder in Internet
Explorer (version 11 or later) to add more
items to the Checkbox and Radio Button
elements without encountering any issues.

6448 -- For the Select file element, you can now
upload a file with a dot (.) in the filename. For
example, Sales.March.jpg.

6448 -- Software version notification for Cloud was not
always displayed in the UI. This issue is now
fixed.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

6448 00633793 You can run a bot when the operational
parameter is used in the SOAP Web Service
action. Previously, the bot encountered errors
when the operational parameter was used in
the action and the corresponding wsdl file
did not have the elementFormDefault
attribute.

6448 00630975 Captured images in a nested If action are now
retained when you check in a bot to the public
repository. Previously, when using any action
that used an image in a nested If action, the
image nested was missing after the check-in.

6448 00630004 When loop is used to read all Unread emails,
the emails are now marked as Read only after
emails are read. Previously, all unread emails
were marked as read when a Loop Break
action was used.

6448 00612913 In Excel Advanced > Remove blank rows,
when you select the Specific row option and
set A1 as the beginning cell, an error is no
longer encountered when you run the bot.

6448 00608265 In the CSV/TXT package, when you use
Japanese OS ANSI (Shift-JIS) as encoding to
read text file content, the Japanese Shift-JIS
characters are now displayed correctly.

6448 00568718 Japanese language supported pop-up
messages no longer appear truncated when
multiple bots are deleted.

6448 00598023, 00611480 In the DLL package, Run function now works
properly and does not display an error or
show broken characters when the parameter
includes Japanese characters.

6448 00638120 When you upgrade from an earlier version
of Enterprise A2019 to a later version and
change the If package version to the latest
one, multiple conditions now appear in If/Else
If after the If package is upgraded. Previously,
some of the conditions did not show in the
logic.

6448 00632228, 00649606 You can now use the Send Email action when
the package version is different in the task and
subtask. Previously, the Send Email action in
the Email package had issues when the task
and subtask had a different package version.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

6448 00544219, 00635206 The Get cell action in Excel Advanced can
now be used without any error. You can use
the Read option to read visible data or the
exact value of the cell.

6448 00646254, 00650712,
00653137, 00658122,
00666883

You can now change the package version
of the If package. Previously, if there were
multiple conditions in the If action, the system
did not allow you to change the package
version.

6448 00613453 Version 11.3 bots that used the Object Cloning
command to find interface objects using
coordinates or image recognition are now
migrated to Enterprise A2019 with the Mouse
> Click action, Simulate keystrokes action,
OCR > Capture area action, or Image
recognition > Find window in window
action.

6448 -- When you run migrated bots that perform
mathematical operations on values containing
decimals or commas, the output from
Enterprise A2019 now matches the output
from Version 11.3.5. Previously, an operation
that resulted in an output of 0.999 in Version
11.3 resulted in an output of 0.9899999 in
Enterprise A2019.

6448 00467664 Fixed an issue where the Universal Recorder
entered characters in a text box incorrectly
when the user configured the Keystrokes
field using a Japanese keyboard.

6448 00630545, 00631418,
00621875

You can now assign input values from a parent
bot in the Task Bot > Run action. Previously,
an issue caused input values to disappear
when a bot containing more than two input
values was saved.

6448 -- The Workload In progress activity page now
displays the Workload bot name instead of the
automation name.

6448 00635306 Fixed an issue where a red error screen
appeared if a bot attempted to pass a file
variable to another bot.

6448 00635326 You can now run bots built using Recorder
package versions from earlier builds.

6448 00616261 You can now pass credential values to the main
bot when you deploy it from the Run bot now
page.
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Problemi risolti

Numero di build ID caso Service Cloud Descrizione

6448 00647135, 00647652,
00647665, 00647144,
00648742, 00646535,
00648883, 00648980,
00654937, 00657039,
00664049, 00663797,
00664138, 00667384

When you upgrade to the latest version of
Enterprise A2019, bots in queued state now
run without any issues because a new token
is automatically generated when an existing
session expires.

6448 00611109 Fixed an issue where the $System:CPUUsage
$ system variable returned an inaccurate value.

6448 00647239 In the Data Table package, when you use the
Merge action to merge two data tables, the
data is now properly merged and the merged
content stores the correct data in the result
data table. Previously, the Merge action had
issues when no header data in a table was
extracted, resulting in incorrect data export to
CSV file.

6448 00444907, 00556374,
00582469, 00628801,
00624681, 00632668

A bot launcher error for a user session is no
longer displayed when you run a bot on a
Bot Agent device registered to a user who is
assigned developer privileges.

Correzioni per la sicurezza

ID caso Service Cloud Descrizione

00552076 The vulnerabilities found in Elasticsearch in Enterprise A2019
are now addressed.

00631233 In the Database package, when you connect to the database,
the username and password are no longer visible in the logs.

Limitazioni note

When you are upgrading from an earlier version of Enterprise A2019 to the current version, the
system displays the error message Self Sign Certificate Failure, and the installation
process is rolled back if both the following conditions occur:
1. The earlier version was installed on a non-default installation path instead of the default path

(C:\Program Files\Automation Anywhere\Enterprise). For example, the previous
version was installed on D:\Program Files\Automation Anywhere\Enterprise.

2. You also select Yes to retain the current installation parameters during upgrade in the message
window that appears after the Welcome screen when the installation wizard detects an earlier
version.

Soluzione: Select No so that you can choose to enter the installation parameters during the
upgrade.
Control Room upgrade fails with self signed certificate failure error (A-People login required)
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Limitazioni note

Service Cloud case ID: 00672719, 00673048
When you are upgrading the Control Room to the current version, the installer uses an
existing or creates a new Elasticsearch data folder in the default path (C:\ProgramData
\AutomationAnywhere\elasticsearch\data) if the Elasticsearch data from the earlier
version is saved to a non-default path. Therefore, the earlier Elasticsearch data and audit logs will
not be available after the upgrade.
Soluzione: Before upgrading to the current version, copy the existing Elasticsearch data from the
non-default path to the default path.

When an Automation Anywhere package is manually uploaded using the Control Room interface,
the Vendor column should show Automation Anywhere. Instead, the interface displays
Unspecified. Automation Anywhere packages that are installed on a server as a part of an
upgrade show the Vendor as Automation Anywhere, which is expected.

For existing device sessions, you cannot use the option to enforce the resolution set at either the
device or Control Room level. The screen resolution set at these levels only work for new device
sessions.

When attended and unattended Bot Runners are run concurrently, attended Bot Runner users
are queued until the unattended Bot Runner session becomes available. This occurs even when
the number of allowed concurrent sessions is not exceeded. For an attended Bot Runner user
deployment, use a single user session to stop them from being queued.

When a user connects to a multi-user device and sets it as their default device, they are taken
through the device registration wizard to enable the Google Chrome plug-in. During the registration
process, users are allowed to select the device type and the concurrent sessions value. Users must
ensure that they set the same value for the concurrent sessions as set by the administrator. If there
is a difference in the value, other users will be impacted.

When a bot is deployed through RDP with a predefined screen resolution, the RDP resolution
settings are not applied correctly during bot execution. The bot is executed with an interchanged
resolution (the height and width pixels are interchanged). For example, if the resolution for bot
deployment is set as 1366x768, the bot is deployed with the resolution 768x1366.
Soluzione: For information about how to resolve this issue, see Automation 360 v.16 - RDP based
deployment does not run bot with pre-defined set screen resolution (A-People login required.

The element label or text appears distorted during bot runtime when you add it in Japanese or any
other non-English language, and the Font name is set to System default.

Service Cloud case ID: 00667210
In Excel advanced, you cannot use the Go to cell action if the Excel sheet does not have data or
if an active cell is out of the worksheet range. This issue is encountered when you use the Go to
cell action and choose the cell option as Active cell with the Beginning of the row, End of the
row, Beginning of the column or End of the column option.
Soluzione: Use the earlier version of the Excel advanced package 4.0.0-20200723-234413
released with Enterprise A2019.15.

HTTP authenticated proxy is not supported for On-Premises users.
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Discovery Bot

Nuove funzionalità

Discovery Bot installer integrated with Enterprise A2019 installer
Enterprise A2019
The Discovery Bot installer is now integrated with the Enterprise A2019 installer. Non è richiesta
alcuna installazione separata per gli utenti Discovery Bot On-Premises. Discovery Bot supports
custom installation for Windows.
Prerequisiti per Discovery Bot alla pagina 2335

Create multi-role users
Enterprise A2019
Combine up to three Discovery Bot system-generated roles and two process discovery licenses to
provide additional functionality for your users.
Create multi-role users for Discovery Bot alla pagina 2339

Create custom role user
Enterprise A2019
Create a unique custom role using the permissions from the Discovery Bot standard user roles
(Admin, Business user, or Analyst roles).
Create a custom role for Discovery Bot alla pagina 2342

Manual aggregated view integrated with Dashboard tab
Enterprise A2019
The Manual aggregated view is now integrated with the Dashboard tab. You can now select
and display recordings and views from the Dashboard, Aggregated, and Comparison tabs,
enabling you to make a change in one tab that will persist across all tabs. This feature enables a
synchronized representation of your metadata for views and recordings.

Internalization, localization, and language support for Discovery Bot
Enterprise A2019
Internalization and localization is now supported for Discovery Bot. For example, you can automate
and translate the UI for your region in French, Spanish, and Italian, among other languages
supported.
Internazionalizzazione, localizzazione e supporto linguistico alla pagina 870

Problemi risolti

ID caso Service Cloud Descrizione

-- You can now sort on the recording ID. The recent recording
(ID) created now displays at the beginning of the list in the
Recordings table.

-- When editing the aggregated view, you can now move the
endpoint upward in the path flow to change the selection of the
steps. You can also move the branch endpoint lower in the path
flow to include more than one step.
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Problemi risolti

ID caso Service Cloud Descrizione

-- You can now select partial steps in a branch, and create and
save an opportunity from the Opportunities tab.

-- The copy field now displays the correct view information from
the view (view ID) that it is copied from.

00673381 If you are using an instance in an AWS special region, you can
now view recordings for users that are successfully completed
(not canceled by the user).

Limitazioni note

When manually editing an aggregated view, if you create a branch in the process flow where a step
was deleted, the step will be missing on the left side of the branch. To add a step on the left side,
you can drag the branch endpoint (small circle) down (below the next step) in the process flow to
add a step back in the branch.
Missing step observed in aggregated view while using A2019.16 Discovery Bot (A-People login required)

When an opportunity is created with 300+ steps, exporting the opportunity to Microsoft Word will
fail.

The Convert to Bot option fails when an opportunity contains 140 or more steps.

IQ Bot Community Edition

The IQ Bot Community Edition is available for this release and has feature parity with IQ Bot Version
11.3.4.2.
Matrice di confronto delle funzionalità per Automation 360 IQ Bot alla pagina 735
Compatibilità delle versioni di Automation 360 IQ Bot alla pagina 740

Importante:  Questo nuovo Community Edition include un'anteprima di IQ Bot con l'estrazione
automatica.

Community Edition for IQ Bot is a special version of our product in the Cloud, available for all users who
want to try RPA and IQ Bot at no cost. Gli utenti non sono tenuti ad acquistare una licenza e non ci sono
limiti di tempo. Tuttavia, vi sono alcuni vincoli di funzionalità, come segue:
• Users can create learning instances using pre-trained Invoices in English only.
• Users can create up to a maximum of 5 learning instances per user account.
• In the Learning Instance list, users can see and access only those learning instances and data created

by them.
• Users can process up to a 100 pages per month for each user account.

Community Edition alla pagina 2467
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New features (using auto-extraction)

Creare un'istanza di apprendimento
Use a pre-trained invoice (document type) to process and validate your documents in English
(only).
Creare un'istanza di apprendimento in Community Edition alla pagina 2468

Extract data from documents
Create a bot to extract data from documents using the learning instance you created.

Validate documents
Validate failed documents manually using the validator form.
Elabora documenti in Community Edition alla pagina 2470

Bot Insight integration
View learning instance dashboard metrics that is integrated with Bot Insight.

Use the IQ Bot (Preview) package
Use the IQ Bot (Preview) package to process and validate documents using Enterprise A2019.

Funzionalità modificate

For the Custom Logic feature, the identified list of Python libraries now includes an additional set
of safe libraries for IQ Bot Community Edition. Go to Automation Anywhere support for a list of the
safe libraries you can use.
List of Pandas Libraries which are supported and not supported on Automation 360 IQ Bot (A-People login
required)

Fixed features (using Auto-extraction)

ID caso Service Cloud Descrizione

00628958 The Task Bot now successfully processes all documents without
displaying any error messages.

Known limitations (using Auto-extraction)

PDF documents with raster format or JBIG2 encoding are not supported.
Soluzione: Prima di elaborare i documenti per l'estrazione dei dati, convertirli in uno dei formati
supportati.

Nota:  Digital PDFs, JPEG, JPG, and PNG are supported formats.

I documenti ruotati non sono supportati.
Soluzione: Pre-process such documents to correct their orientation before data extraction.

Only a predefined set of form and table fields are supported. The table header does not support
multiple fields in a single column.
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Known limitations (using Auto-extraction)

During the validation process, if a user deletes all rows from a table, the user is unable to add a
new row.
Soluzione: Perform these steps:
1. Cancel the validation user form and open the document again.
2. Create a new row before deleting the unwanted rows.

Documents that are pending review from Enterprise A2019.15 cannot be validated in Enterprise
A2019.16 using the Review documents option.
Soluzione: Create a Task Bot using the IQ Bot Validation action in the Enterprise A2019.15
package, and validate the review pending documents.

IQ Bot

Nuove funzionalità

Updates to IQ Bot Pre-processor package
On-Premises e Cloud
You can now perform the following tasks using the new actions in the IQ Bot package:
• Link or combine two images using Concatenate image
• Adjust the size of the selected image file using Edit image
• Enhance the image resolution and other aspects using Enhance image
• Change the image orientation such as angle using Orient image

IQ Bot Pre-processor package alla pagina 1647

IQ Bot [Local Device] package enhancements
The IQ Bot [Local Device] package now enables you to add custom logic (Python scripts) in the
Designer to extend text extraction and validation capabilities.
Add custom logic in IQ Bot to improve extraction

Problemi risolti

ID caso Service Cloud Descrizione

00590165 You can now train the selected document because error
messages are no longer displayed when you click Learning
instances > See extractions for a group.

-- If you remove a bot (Delete a bot) associated with a document
from the staging environment, you must create a group before
uploading this document to the production environment. After
deleting the bot from the staging environment, you can now
create or edit the group when you upload the same document
to the production environment.
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Problemi risolti

ID caso Service Cloud Descrizione

00601840 You can now view a public bot without any errors when you
click BOTS > My bots > PUBLIC in Enterprise A2019.

00672482 You can now validate documents with a large number of fields
(more than 100) and navigate between multiple documents
without any issues on the Validator.

00648013, 00670191 Ora puoi migrare, esportare, importare o scaricare file di backup
dell'istanza di apprendimento IQ Bot (.iqba) fino a 1,4 GB. The
previous limit was 600 MB.

Limitazioni note

Migration of learning instances does not get completed if the IQBA file size is more than 2 GB.
Soluzione: Migration of learning instance is not getting completed if the IQBA is more than 2GB (A-People
login required)

In the IQ Bot Designer, sometimes while training documents when the user clicks See extraction
results, an error message appears and the user cannot proceed with the task.

You cannot access Cloud OCR through a proxy server in IQ Bot.

In IQ Bot Community Edition, when you click New instance to create a learning instance, the My
learning instances page appears and then automatically reloads after a few seconds.
Soluzione: Wait until the page reloads before you start entering the details to create a learning
instance.

Bot Insight

Nuove funzionalità

Power BI connector available as part of Microsoft Power BI desktop
Enterprise A2019 and Community Edition
The Automation Anywhere connector for Bot Insight is now certified and officially a part of the
Microsoft Power BI Desktop August release.
Data connector for Power BI alla pagina 2980

Business analytics support for attended Bot Runners
Enterprise A2019 and Community Edition
Business analytics data is now logged when bots are run with attended Bot Runners licenses. Also,
a new attribute User Name is available in the Business Dashboard in Transaction Data. This
attribute shows the user who is running the bot.
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Funzionalità modificate

Convert bot duration metric to percentage
In the Device dashboard, when you select the metric as Bot Duration, you have an additional
option to convert the bot duration to percentage. This option appears only if a selected group or
subgroup is of date type variable.
Operations dashboard alla pagina 2959

Limitazioni note

Due to security reasons, you cannot access the following Bot Insight APIs and a 403 forbidden
error is displayed.

GET/v2/botinsight/data/api/gettasklogdata
GET/v2/botinsight/data/api/gettaskvariableprofile
DELETE/data/api/deletetasklogdata
GET/data/api/getbotrundata
GET/data/api/getaudittraildata

Automation Anywhere Robotic Interface (AARI)

Importante:  This AARI version is available for all users starting from Enterprise A2019.16.

Nuove funzionalità

Assign tasks
Enterprise A2019
AARI managers and users can now assign tasks. Managers can assign and reassign tasks to any
users from teams with an assigned process. Users can assign tasks to other users of the same
team.
Assign or unassign a task alla pagina 2167

Filter and search tasks
Enterprise A2019
AARI users can now perform the following tasks:
• Filter, sort, and search tasks for quick results
• Search task names using Search Title
• Sort by completed, pending, and unassigned tasks using the Filter option
• Configure results based on assignee or title using Advanced filter
• Click a column to sort by ascending or descending orders

Filtrare e cercare un'attività alla pagina 2170.

Summarized information of tasks
Enterprise A2019
The Tasks tab in the main page shows statistical insight for the numbers of completed, pending,
and unassigned tasks.

© 2023 Automation Anywhere. All rights reserved.     538



    Automation Anywhere - Learn

Nuove funzionalità

Process package
Enterprise A2019
The Process package enables users to create a request inside a specified process from a bot.
Process package alla pagina 1744

Preview bot
Enterprise A2019
Human Tasks and Bot Tasks now include the Preview bot option, which enables users to
quickly preview relevant bot or forms information.

Process editor metadata
Enterprise A2019
Human Tasks and Bot Tasks now accept username and email metadata. Users can enter the
name and email values to their process workflow such as $Task.assignedTo{username}$ and
$Task.assignedTo{email}$.

Enhancements to roles
Enterprise A2019
The AARI admin can now assign a process to a team they created and become the manager
assigned to that process. The admin can also assign a process to a team they did not create and
the manager of that team is assigned to the process.

Administration permission
Enterprise A2019
The AARI admin and manager are now assigned a new Administration permission by default
called View Users and Roles basic information. The admin can now view the process
management page to assign or unassign managers.

Funzionalità modificate

Process management page
The process management page in AARI on the web is now removed for managers.

Password field in request view
The Password element is now removed when viewed in the request tab.

Problemi risolti

ID caso Service Cloud Descrizione

-- A team name is no longer limited to 20 characters.

-- When you open many request tabs, the navigation bar now
functions properly and allows you to navigate to your tabs by
using the arrow icon.

-- When you view tasks in the request view, the request and task
now show the correct status.
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Problemi risolti

ID caso Service Cloud Descrizione

-- The manager can now be removed in the process management
page.

-- The bot status in the request view is now represented as a
progress bar.

-- The Element name field in the process editor now shows the
correct error message when the field contains spaces.

-- When you select the Make field uneditable option for the
Checkbox, Date, Dropdown, Number, Password, Radio
Button, Text Area, and Text Box elements, the values can no
longer be edited.

-- The team management page now shows the Owner column.

-- When number values are entered in a number field, such as a
phone number box, the values are now accepted.

-- In the device pool configuration page, the Bot Runner users
check box is now selected.

-- The Checkbox and Radio Button elements now support
horizontal format.

-- The Document element can now access the Open the doc in
browser link.

-- The Number element values are no longer limited to 8
characters and can now be rendered properly when the values
contain trailing zeroes, commas, and decimals.

-- When you select the Insert a variable option in the process
editor, the Variable field now shows specific variable names.

-- The redo functions now works properly in the process editor.

-- The Text Box element now accepts number-only inputs.

-- The timestamp of the closing step now shows the timestamp of
the last step in request view.

-- When you access a public process, the existing variable in the
field can no longer be changed.

-- The Masked data option is now fully supported for all
elements.

-- When you edit a checked-out process that contains conditional
steps with variables, you can now edit and save these
conditional steps.

-- When a process is configured with two forms that contain
a Dropdown element, the process creation shares the
Dropdown element data between the forms. The Dropdown
element in the second form now receives data from the first
form.

-- The manager can now access their team without encountering
any errors.
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Problemi risolti

ID caso Service Cloud Descrizione

-- You can now update values in a prepopulated text field in
request view.

-- When you create a request and encounter a preprocessing error,
the request creation ends and the request view now shows the
failed status.

-- The Go To option in the process editor now shows the Human
Task or Bot Task name.

-- Users with the AARI manager and user roles are now
automatically redirected to the web interface when they access
the Control Room URL.

Limitazioni note

When you provide your Bot Task and Human Task the same element name, an error occurs for
the Go to element, but the process editor does not prompt an error.
Soluzione: Create unique element names for your Bot Task and Human Task.

When you create a form that contains a Document element and access your Human Task in the
process editor, you cannot assign your variable because the Add element option is not available.

The Display message field in the If/Else pair action does not function correctly when displaying
a message in request view.

The titles (Title field) of completed requests in AARI on the web are replaced by endpoint display
names.

When you create a form that contains a Number field set to a 10-character limit and you enter
1234567890 in the number field in request view, the number values are not accepted.

When you create a process with a form that contains a Date element, the Condition option in the
If/Else pair action does not allow you to enter a variable.

Previous Automation 360 Release Notes
Review the release notes for previous Automation 360 releases.

Note su Enterprise Edition A2019.15

Data di rilascio: 14 August 2020

Review the new features, supported packages, changed features, fixed features, security fixes, and known
limitations in the Enterprise A2019.15 (Build 5933) release. IQ Bot and Discovery Bot are on Build 5931.
• Enterprise A2019 on page 542
• Discovery Bot on page 551
• IQ Bot on page 552
• Bot Insight on page 555
• Automation Anywhere Robotic Interface on page 556
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Enterprise A2019

To verify which  version is compatible with this release, see Compatibility with release builds on page 1026.

Nuove funzionalità

Introducing Discovery Bot and Automation Anywhere Robotic Interface
Enterprise A2019
Discovery Bot on page 551 | Automation Anywhere Robotic Interface on page 556

Migration from Enterprise 11 and Enterprise 10 to Enterprise A2019 (currently available
only to those in the Migration Early Adopter Program)
Enterprise A2019
Migration to Enterprise A2019 is currently only available to select customers through our Migration
Early Adopter Program. If you are interested in learning more about this program or a timeline
for when migration will be available to all customers, contact your Automation Anywhere
representative.

Perform an action on multiple objects of the same type
Enterprise A2019
The variable anchor in AISense Recorder enables you to perform an action on multiple objects of
the same type.
Use variable anchor

Run Enterprise 11 bots from Enterprise A2019
Enterprise A2019
The V11 TaskBot package enables you to run Enterprise 11 bots from Enterprise A2019 in the
Enterprise 11 Control Room.
V11 Task Bot package on page 1918

Enhancements to the Interactive forms
Enterprise A2019
Interactive forms include the following updates:
• You can include the Dynamic element of the selected form in the Change label action.
• In the Dynamic area actions:

• You can add a maximum of four elements for the Add row in Dynamic area action.
• In the Add element screen, use additional options from the Type drop-down menu such as

Checkbox, Dropdown, File, Snapshot, RadioButton, Text Area, and TextBox.

Interactive forms package on page 1638
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Nuove funzionalità

Support for interactions with Oracle EBS tables
Enterprise A2019 and Community Edition
Use the Universal Recorder or the Recorder > Capture action to read data from an Oracle EBS
table. The following actions are now supported:
• Get Total Row
• Get Total Column
• Get Cell text by Index
• Get Cell index by text

Expanded data type support in DLL package
Enterprise A2019 and Community Edition
The DLL package now accepts dictionary and list variables as input parameters or to hold action
output.
Using the Run function (Legacy) action on page 1487

Create device pools using API
Enterprise A2019
You can now create a device pool and add unattended Bot Runners to the device pool using an API.
This API uses deviceIds, automationScheme, ownerIds, and consumerIds as parameters to
create a device pool.
Device Pools API

Pacchetti supportati

Pacchetto Versione

Gestione nodi 12.1.6000

Application 2.0.0-20200721-221935

App Integration 1.0.0-20200721-221933

Analizza 2.2.3-20200624-011702

Active Directory 2.0.1-20200721-221930

Boolean 2.0.0-20200721-221936

Migrazione bot 2.4.0-20200604-174031

Browser 2.0.0-20200721-221938

Clipboard 2.0.0-20200721-221947

Comment 2.0.0-20200721-221948

CSV/TXT 2.0.0-20200726-052504

Database 2.0.0-20200723-022707

Data Table 2.0.0-20200721-222456

Datetime 3.0.1-20200721-222000
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Pacchetti supportati

Pacchetto Versione

Delay 2.1.0-20200721-221959

Dictionary 2.0.0-20200624-041629

Run DLL 2.0.0-20200721-222437

Email 2.0.0-20200721-222003

Error handler 2.0.0-20200721-222009

Excel basic 2.0.0-20200721-222339

Excel advanced 4.0.0-20200723-234413

File 2.1.0-20200624-041638

File & folders 2.1.0-20200721-222011

Folder 2.1.0-20200721-222013

FTP / SFTP 2.0.0-20200721-222017

IF/ELSE 2.0.0-20200721-222021

Image Recognition 2.0.0-20200721-222024

Moduli interattivi 2.15.0-20200729-084624

IQ Bot 2.0.0-20200415-125005

JavaScript 2.0.0-20200721-222202

Simulate keystrokes 2.1.0-20200721-222204

Legacy Automation 2.0.0-20200721-222207
1.0.0-20200515-133334

List 2.0.0-20200721-222211

Log To File 2.1.0-20200721-222212

Loop 2.0.0-20200721-222213

Message Box 2.0.0-20200721-222213

Migrazione 2.4.0-20200728-033126

Mouse 2.0.0-20200721-222218

Number 2.0.0-20200721-222224

OCR 2.1.0-20200721-222225s

Office 365 Excel 2.0.0-20200721-222319

Office 365 Calendar 2.0.0-20200721-221944

Office 365 OneDrive 2.0.0-20200721-222326

PDF 2.4.0-20200721-222331

PGP 2.1.0-20200721-222333

Ping 2.0.0-20200721-222334
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Pacchetti supportati

Pacchetto Versione

Stampante 2.0.0-20200721-222342

Play Sound 2.0.0-20200721-222335

Prompt 2.0.0-20200721-222344

Python Script 2.0.0-20200721-222345

Recorder 2.0.6-20200626-193519

REST Web Service 2.0.0-20200721-222436

SAP 2.1.0-20200723-234637

Screen 2.0.0-20200721-222442

SNMP 2.0.0-20200721-222445

SOAP Web Service 3.0.0-20200721-222448

String 3.0.0-20200721-222454

System 2.0.0-20200721-222454

Attività 2.0.0-20200624-103759

Terminal Emulator 3.2.0-20200721-222500

Trigger Email 1.1.0-20200721-222511

VBScript 2.0.0-20200721-222503

Wait 3.0.0-20200721-222505

Window 2.0.0-20200721-222507

Workload 2.0.1-20200721-222508

XML 2.0.0-20200721-222509

Funzionalità modificate

User validation for change in authentication type (Service Cloud case ID: 00602788)
Enterprise A2019
The username is now validated when an admin user updates the Control Room authentication
configuration from Database to SAML (Administration > Settings > User Authentication).
An error message appears if the username already exists.
Configurazione dell'autenticazione SAML on page 995

The Before and After fields in the String > Extract action are now optional (Service Cloud
case ID: 00617151)
Enterprise A2019 and Community Edition
Users can now build and run bots that do not have a value in the Before or After fields. This
ensures migrated bots that contain the String > Extract action can run without disruption.
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Funzionalità modificate

Improved debugging for Image Recognition actions
Enterprise A2019 and Community Edition
When a bot fails while running one of the Image Recognition actions, the captured source and
target images are stored in the log folder. Users can review the images to identify issues such as
the application image not captured correctly or low quality of the image due to differences in the
Bot Creator and Bot Runner devices.
Image Recognition package on page 1631

Problemi risolti

ID caso Service Cloud Descrizione

00609293 The AATaskName system variable now uses a backslash (\)
to support the migration of Enterprise 11 bots that use this
variable to Enterprise A2019.

00600367, 00620149 When calling REST APIs for using the REST Web Service
command, the API now returns the correct status and the
response code.

-- When Work Items are processed for automation in the Bot
Agent, you can now view the workload automation name in
the Workload > Queue > View Activity in progress and
Run bot with queue > View pages, even when the workload
automation ID and schedule automation ID are the same in the
Control Room database.

00606636 The migration of 11.3.x bots that read a date from a file to
an Enterprise A2019 variable now results in the correct date
format: dd/mm/yyyy. Previously, a series of numbers were
displayed in Enterprise A2019.

00576004 Fixed an issue where some emails were retrieved with HTML
tags, even when the user selected the Plain text option.

00585830 Fixed an issue where the Loop > For each meeting in
calendar iterator only returned details for the first meeting of
the day. Now, the output variable refreshes after each iteration
and returns details for each meeting.

00505228, 00576757 When the browser language is set to Japanese, error messages
from the Control Room > Administration > Settings >
Email page are now displayed correctly. The distorted Japanese
character issue is now fixed.

-- You can now check in any forms or bots in the Public folder
that were created using any of the earlier versions of Enterprise
A2019.

-- You can now use the Get action without any errors for an
empty dynamic element of a form during bot runtime.

00575400, 00597633 You can now use Email trigger to start a bot even when
Microsoft Office is set to a non-English language.
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Problemi risolti

ID caso Service Cloud Descrizione

-- If you are using the Snapshot element, the form is no longer
minimized even if you set an invalid file path to save the
snapshot during bot runtime.

00566225 If you add a form with a Japanese name, error messages are
not displayed during bot runtime.

00571773 If you have added element label or text in Japanese and set
Font name > System default, the form elements are now
displayed without any distortion during bot runtime.
Create a form on page 2186

00620911 For the Select file element in a form, the file path is now
displayed correctly when you select a file with a Japanese name
during bot runtime.

-- If a form has a Dynamic field, any errors within any of the
available elements are now displayed immediately during bot
runtime.

-- An error is now displayed if you use the Tab key to navigate out
of the Dropdown element in a form during bot runtime.

00616251 If a Bot Runner (attended or unattended) user is running a bot
and an event trigger that is associated with this user starts, the
event trigger is now queued and deployed after the current bot
has completed.

00557617 The Simulate keystrokes action now supports ASCII characters
when the device language is set to Russian.

-- Installing cloud-based license files is now supported on Control
Room deployments using Linux CentOS 7.

00615038 All packages and actions now work with the “Portuguese
(Brazil)” browser language. Previously, some packages
and actions caused an unresponsive Control Room when
“Portuguese (Brazil)” was selected as the browser language.

-- You can now reset the password successfully when the service
credential expires or is disabled. Previously, users intermittently
experienced issues while resetting the password.

-- The default logging for Bot Agent is no longer in debug mode.
Previously, debug mode was the default logging, which caused
an increase in the number of logs and resulted in high storage
space and decreased system performance.

00588077 If you create a copy or edit the content of an existing CSV file,
the modified content that is uploaded in the Control Room will
now display correctly and will not cause any run-time error
when the bot is executed.

00541524,00531540 You can now run bots even when the path of the bot location
is more than 255 characters. Previously, the bot failed with an
error.
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Problemi risolti

ID caso Service Cloud Descrizione

00615106 The Bot Scanner now analyzes large bots within a few minutes.

00610366 Keyboard shortcuts such as Ctrl+C, Ctrl+V, and Ctrl+X work as
expected on Internet Explorer.

00577850, 00608065, 00597132,
00596397, 00619463

The Control Room now does not become unresponsive after a
period of inactivity.

00608824 An error is no longer encountered when a bot opens the Excel
application after it is forcefully terminated.

00542144 The wait option in various packages now works as expected
for applications based on HTML technology. Previously, the
wait option used to wait for a period in multiples of 15 seconds
based on the value provided. For example, if the wait value was
in the range of 1-14, the system waited for 15 seconds.

00508478, 00504802, 00569822 An error is no longer encountered when a bot is running and an
application window is closed when the bot is performing the find
window operation.

00494857 A user that does not have the Register device permission can
no longer register a device by creating a custom Bot Creator
role.

00501619, 00614130, 00620198 An error is no longer encountered when a user deletes a device
after upgrading to a later version of Enterprise A2019.

00616786 Fixed an issue where periodic scheduled bot deployments failed
with the following error message (even though the credentials
provided by the bot is correct):
Either your username or your password is
incorrect. This might be due to a misspelling,
your Caps Lock might be on, the password might
have expired, or the domain might be required.
To continue, retype your username and password.

00494893 Fixed an issue where the Error handling > Catch action was
not handling a runtime error with the record variable. Previously,
the Catch action did not capture an index out of bounds
error when the record variable was entered in a Message box
action with the index specified by name.

-- The Get Property datetime format within the Active Directory
package now displays the information using the system
datetime format.

-- When you edit a bot using a previous package version (for
example, Enterprise A2019.13 version) and the Desktop
session automatically starts, if you exit the Bot editor while
the Desktop session is trying to launch, the current package
version will now be displayed when you open a new Bot editor
instance. Previously, the previous package version (for example,
Enterprise A2019.13 version) was displayed.
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Problemi risolti

ID caso Service Cloud Descrizione

00563346 Credentials with non-ASCII characters are now allowed to be
stored in the Credential Vault in the Control Room. Therefore,
when you run TaskBots to open files that are protected using
passwords containing non-ASCII characters, the application
does not respond with an HTTP 500 error.

00525552, 00470841 The Run task no longer fails when the child bot name contains
allowed special characters. Previously, when the child bot name
contained allowed special characters, the run task displayed an
error message.

00501212 Fixed an issue in the SMTP settings where the Control Room
was sending notification emails for all of the conditions,
including the disabled conditions.

00607005 A security scan of Enterprise A2019 no longer reports the
Recorder package as a malicious software. Previously, the
security scan reported it as a malicious software because the
check.exe file was missing the root identification certificate.

00564129 On an operating system configured for Japanese, the Roles
pages in the Control Room now shows English text as expected
when you select English in the Control Room language selection.

00629523 When you upgrade from an earlier version of Enterprise
A2019 to a later version and change the If package version
to the latest one, conditions combined with the AND or OR
condition now appear in the logic. Previously, except for the
first condition, the rest of the conditions with the AND or OR
condition were not shown.

00631477 When Work Items from multiple queues are processed for
Workload automation from one device pool with the round-robin
method for a time slice of 5 minutes, the Workload automation
does not run in a loop and thereby causing an increased CPU
usage.

00633829 As system admin permissions for Workload automation are
verified by the application when you run a bot with queue
from a single device pool to process multiple Work Items
concurrently, CPU usage does not increase drastically.

00615086 Fixed an issue where the Java Application Launcher continued to
run after a user stopped the Bot Scanner, which caused device
performance issues for some users.

-- Variables of the List type are now available for migration from
Enterprise 10 andEnterprise 11 to Enterprise A2019.

00607949 Disabled packages will not be enabled when you upgrade
from an earlier version of Enterprise A2019 to a later version.
Previously, packages that were disabled were enabled after an
upgrade.

-- You can now debug a bot with watch variables that contain
Japanese characters. Previously, watch variables containing
Japanese characters did not output a value.
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Problemi risolti

ID caso Service Cloud Descrizione

00623186, 00624876, 00624060,
00627123, 00629873, 00639523,
00630880, 00634577, 00636166

The correct status of a deployed bot now appears instead
of Device yet to be determined in the Control Room
Activity page, and the user is allowed to delete the device that
has completed running a bot. The following message no longer
appears: Device is part of active deployment.

00573461 Fixed an issue where a bot was failing in preprocessing mode
if the user had inserted and then disabled the Error Handler
> Catch action without also disabling the Finally or Catch
actions.

00629046 In the Database package, when you use Microsoft Excel as a
database, the bot launcher now executes properly. Previously,
the bot launcher stopped working when reading data from an
Excel sheet that had some empty rows.

Correzioni per la sicurezza

ID caso Service Cloud Descrizione

00491697 The Transport Layer Security (TLS) protocol using CBC mode
of encryption for configuring the network security of the
Control Room is now secured from man-in-the-middle or
cyrstallographic timing attack.

Limitazioni note

When you add a form with the Dynamic element to a bot, click Add element, select Dropdown
or Radio group as the Type, and leave the Default value/ Default path field blank, the
elements appear as labels during bot runtime.

You can move a form around by dragging the title bar during bot runtime.

When you copy and paste the filepath for the Select file element of a form during bot runtime,
invalid characters are displayed.

When the Set focus action is assigned to a disabled form element, an error icon is displayed when
the focus is lost during bot runtime.

When you enable any of the disabled fields during bot runtime, error icons are not displayed.

Error messages during bot runtime are not displayed in the language selected in the Control Room.

If email trigger is used to start a bot, the status of the most recent email that you have viewed is
changed to Unread every time any bot is triggered based on the trigger interval set in the Check
every drop-down menu.

In an Control Room configured for Active Directory users, the following message appears after the
first admin user is created: Do you want to leave this page?
Soluzione: Click Stay on page so that you can go to the Control Room login page.

If the device is already registered by a user other than the Bot Creator and the Bot Creator has the
Register device permission, then when you run a bot from the Bot editor window, the deployment
fails at the Connecting your computer to Enterprise Control Room step.
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Limitazioni note

The migration process does not migrate manual dependency files added in the Enterprise 11
Control Room using the API. Bots associated with these dependencies will be migrated successfully
but will fail during execution because the system cannot find these dynamically added dependency
files at runtime in Enterprise A2019.

When a bot execution is in progress and the Control Room server refreshes, the progress status of
the In-Progress activity will not be displayed even though the bot execution continues without
interruption.

Discovery Bot

Introduction
Discovery Bot enables process automation by capturing document processes, identifying automation
opportunities from business processes, and prioritizing opportunities based on ROI. Users can convert
these opportunities into automated processes.
Process discovery by using Discovery Bot on page 2328

Limitazioni note

Discovery Bot is not supported in high availability (HA) mode. When two Control Room instances
are used in a cluster configuration, the recording artifacts are split between the two Control Room
instances and the recording might fail to process.
Soluzione: To enable Discovery Bot in HA mode, you must update the
processdiscovery.properties file to point to the repository path specified in the Control
Room:
1. From the Control Room, go to Administration > Settings > General.
2. Select the Control Room Database and Software tab.
3. Scroll to the Control Room Repository section.
4. Copy the path specified in the Repository path field.
5. Go to C:\Program Files\Automation Anywhere\Enterprise\config.
6. Open the processdiscovery.properties file.
7. In the processdiscovery.data.staging path, paste the repository path in

the <yournetworkshareddrive> here: \\<yournetworkshareddrive>\
\Processdiscovery\\staging\\data

8. Restart the Discovery Bot service.

When HTTP proxy is installed in a cloud environment, you can use the Discovery Bot recorder to
record processes.

Custom role setup for Discovery Bot is currently not supported.

The Discovery Bot recorder continues to record your steps even after you have logged out of the
Control Room.

Note:  Manually stop the recorder to end the recording session.
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Limitazioni note

The Discovery Bot recorder displays an internal error message when accessing Google Apps. Pause
the recording and then resume the recording again to recapture the steps.

The recent recording (ID) created is displayed at the end of the list in the Recordings table. You
cannot sort on the recording ID at this time.

The recording count for a process is incremented by one even if a user stops or cancels a recording
session. The incremented number is displayed in the Recordings section in the tile for a process.

By default, you cannot move the endpoint in an upward direction in the path flow to change the
selection of the steps. You can move the branch endpoint lower in the path flow to include more
than one step.

You must add at least one step to a branch for you to select the branch and create an opportunity.

You must select all steps in a branch to create an opportunity. Selecting partial steps in a branch
will result in branch being dropped in the opportunity that is displayed from the Opportunities
tab.

Currently, the copy of field does not display the correct view information from the view (view ID)
that it is copied from.

If the Control Room is not installed in the C:\ drive ( C:\Program Files\Automation
\Enterprise), the Discovery Bot installer fails to install correctly. If the Control Room is not
installed in the C:\ drive, then perform the instructions provided in this article:A2019.15 Discovery
Bot installation issue with non-OS drive (A-People login required).

The Export to Word option supports a maximum of 500 steps.

The Convert to Bot option supports a maximum of 500 steps.

Funzionalità modificate

.

IQ Bot

Review the compatibility of the IQ Bot On-Premises version with the corresponding Control Room On-
Premises version.
Compatibilità delle versioni di Automation 360 IQ Bot on page 740
For feature information about IQ Bot, see Matrice di confronto delle funzionalità per Automation 360 IQ Bot on
page 735.
The IQ Bot Cloud version provides users with automatic provisioning for up to three environments such as
Development, Test, and Production.

Note:  IQ Bot Build 5931 is compatible with Enterprise A2019 Build 5933.
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Nuove funzionalità

New IQ Bot Pre-processor package
On-Premises e Cloud
The following new actions are available as part of the IQ Bot package:
• Convert image to PDF
• Get barcodes
• Get document info
• Get page content

IQ Bot Pre-processor package on page 1647

Search by filename in Validator
On-Premises and Cloud (Service Cloud case ID: 00372981)
Use the Search by filename field in the Validator screen to search a document in IQ Bot.
IQ bot Validator enhancements

IQ Bot [Local Device] package  (currently available on request only)
On-Premises e Cloud

Important:  Contact your Automation Anywhere representative to request the On-Premises
package. For Cloud, it is available as a pre-installed package.

Use the IQ Bot [Local Device] > Process documents action to process documents using
TaskBots created in the Control Room. You can scale by processing documents on multiple devices
simultaneously without setting up a separate IQ Bot cluster. You can set this up using workload
management in the Control Room.
Gestione del carico di lavoro on page 2797
The validation is done using the current IQ Bot Validator and usage metrics on the dashboards,
which is available with the installed IQ Bot server.

Note:  You can create validators using interactive forms if they do not want to send data to the IQ
Bot server.

IQ Bot [Local Device] package on page 1645

IQ Bot Classifier package (currently available on request only)
On-Premises e Cloud
The IQ Bot Classifier package enables you to group documents into appropriate learning instances
for content extraction.
This package is not available as part of the standard IQ Bot installation.

Important:  Contact your Automation Anywhere representative to request the package.

IQ Bot Classifier package on page 1641
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Nuove funzionalità

Migrate learning instances using Migration Utility
On-Premises e Cloud
Use the Migration Utility feature to migrate learning instances from one environment to another.
Additionally, you can back up, restore, download, delete, and upload learning instances.
Migrazione delle istanze di apprendimento on page 1347

Control creation of groups
On-Premises e Cloud
Use the New groups creation setting section in the Learning Instance > Edit page to limit
creating groups when uploading training documents to IQ Bot. Use the Threshold to create new
groups value and Never create new groups check box to define the parameters.
Bots

Funzionalità modificate

For the Custom Logic feature, the identified list of Python libraries now includes an additional set of
trusted libraries for IQ Bot On-Premises and Cloud. Go to Automation Anywhere support for a list of
the safe libraries you can use.
List of Pandas Libraries which are supported and not supported on Automation 360 IQ Bot (A-People login
required)

Problemi risolti

ID caso Service Cloud Descrizione

00376179 The Automation Anywhere Cognitive Project is now created
without any errors even when you use the IQ Bot batch files to
install or uninstall IQ Bot.

00560185 The Download Document in IQ Bot now runs without any
errors, irrespective of the language in which the learning
instances are saved.

00574815 You can now use the Google Vision API engine to classify the
selected PDF files without creating any unclassified groups.

-- Documents are now classified correctly by the Google Vision API,
irrespective of the display limitations set. Previously, an incorrect
resolution limitation created unclassified documents.

-- You can now use Internet Explorer to save a document or mark it
as invalid in the learning instances validator screen, without any
error messages.

00620237, 00623175 After logging in to the Control Room as an IQ Bot administrator,
the IQ Bot tab is no longer displayed in the navigation bar.

-- The Output.csv file generated for a validated document and
validated data are now displayed without any error messages.
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Problemi risolti

ID caso Service Cloud Descrizione

00605607 When you click Save current document in the validator screen,
the document is saved without any errors and the corresponding
.csv file is created in the output folder.

-- IQ Bot deletes learning instances from Community Edition if they
have not had activity in 60 days.

Limitazioni note

IQ Bot On-Premises e Cloud
When you click the Save and go to next group option, the available groups or the learning
instances are sometimes not displayed.

IQ Bot On-Premises e Cloud
A validation error message along with the corrected field is displayed in the output (.csv) file for
documents validated using ValidatorURL.

IQ Bot Cloud (Service Cloud Case ID: 00647700, 00657619, 00656643)
The output (.csv) files are not downloaded even when you click Download all documents
button, and an error message is displayed.
Contact Automation Anywhere support for more information.

Bot Insight

Nuove funzionalità

Date Interval option
Enterprise A2019
When you create new widgets that support date fields for a group or subgroup, the Date Interval
option is enabled with the default option set to Month.
Configuring a Line Bar Chart query on page 2977

New clustered line bar chart widget
Enterprise A2019 and Community Edition
The Clustered Line Bar Chart widget enables you to view and analyze information about your
metrics and attributes. You can provide two metrics and two attributes in your clustered line bar
chart. Now when two attributes are selected, a clustered graph grouped by primary and secondary
attributes is displayed.
Bot Insight visualizations on page 2976
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Nuove funzionalità

New Device dashboard in the Operations dashboard
Enterprise A2019 and Community Edition
The Bot Insight Device dashboard displays various widgets that provide information about the
utilization of the machines on which the bots are executed. You can analyze the device utilization
and activity history of different Bot Runner machines.
Operations dashboard on page 2959

Problemi risolti

ID caso Service Cloud Descrizione

00540647 Dates are now displayed correctly on the
dashboard after the data is grouped based on
the date. Previously, incorrect dates were shown
on the dashboard.

Deprecated feature

The Widget Event Distribution by workbench is removed and will no longer be displayed in
the Audit Dashboard.

Automation Anywhere Robotic Interface

Introduction
Automation Anywhere Robotic Interface (AARI) enables users to design a process workflow to address
their business requirements. The processes incorporate human and bot tasks using forms to define
parameters and render supported UI elements on the web. When using AARI on the web, users create
requests to use their created process workflow for process instances (case) and run their tasks.
AARI is available as a part of the Enterprise A2019 installer. You can view the AARI components in the
Administration page.
Configure roles for AARI on the web on page 2115

Important:  This AARI version has limited availability and is available only to sales and internal users.

Limitazioni note

When you edit a checked-out process that contains conditional steps with variables, you cannot edit
and save these conditional steps. The steps will revert any new variables you add.
Soluzione: Delete and add a new condition.

The If, Else If, and Else actions cannot be placed before another bot logic in your workflow. You
can only place these actions at the end of the bot logic.
Soluzione: Make a clear boundary on the conditional block.
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Limitazioni note

In a process, when you use a date format such as 2020/07/04 in the input_date field in Bot
Task, the bot does not accept the date input.
Soluzione: Create a separate date variable to use an input.

Form elements that are not supported and are deleted by the process editor include: Button,
Dynamic, Select File, and Snapshot.
Soluzione: Instead of using the Button element, add a form action.

The Import bots and Export bots user interface labels do not match for a process but are still
applicable to importing or exporting a process.

When you access a public process, the Request display name field in Process entry is not
locked and can be edited. The existing variable in the field can be changed but not saved.

The Task display name option in Process entry has a field set to initialData that cannot be
edited in the process editor.

The Feed data into form table in the process editor does not allow editing.

The Element name field in the Bot Task and Human Task cannot contain spaces.

When you create two forms and assign the data of the first form to the second form using
$FormStep.input[]$, the second form data is not evaluated.

Redo functions are only available for canvas interactions. The redo functions are not available by
default until your first canvas interaction. The functions are available again when you interact with
your second canvas.

A team name that has a length of 20 characters or more is not accepted.
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Limitazioni note

Limitations in AARI on the web

Navigation bar When you open too many request tabs, the tabs
are hidden in the navigation bar.

Timestamp The timestamp of the closing step shows a
duplicate timestamp of the starting step in
request view.

Imported process When you export a process from an Control
Room and import that process as public to
another Control Room, the imported process
cannot be viewed.
Soluzione: You can check in and then check
out the process, or import the process as private
and then do a check-in.

Configuration page In the device pool configuration page, the Bot
Runner users check box cannot be deselected.
Soluzione: Double-click the check box in the
header.

Process management page A check-in process that is deleted from the
Control Room repository is still visible in the
process management page.

Form rendering • The Masked data option is not fully
supported for all elements. When this option
is added to hide data, the data is visible.

• The Checkbox and Radio Button elements
do not fully support horizontal format. When
these elements are configured to display
horizontally, the elements are displayed
vertically instead.

• The Document element is not fully
supported. When this element is configured
to a Default file path, the entire document
is not rendered.

• The Number element encounters issues
with large numbers. When this element is
configured to contain three number fields
and number values with trailing zeroes,
commas, and decimals, these values are
not honored and are not rendered. When
number values are entered in a number field,
such as a phone number box, the number
values are not accepted.

• The Text Box element encounters issues
with number-only input. When this element
is configured in a form to submit data, the
Submit option is not enabled when the field
contains only numbers.

• The Password element encounters
issues with maximum character limits.
The maximum limit is not enforced when
a password is entered in the initial form.
This element does not contain values when
submitted in the request tab.

• The Select File element does not support
the Open the doc in browser link. When
this link is open in the initial form, the link
redirects to the web main page.

• When a process is configured with two forms
that contain a Dropdown element, the
process creation shares the Dropdown
element data between the forms. However,
when you view the data in the request tab,
the Dropdown element in the second form
does not receive data from the first form.
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Note su Enterprise Edition A2019.14

Data di rilascio: 9 July 2020

Review the new features, supported packages, changed features, fixed features, and known limitations in
the Enterprise A2019.14 (Build 5322) release. There are no security fixes in this release.
• Enterprise A2019
• IQ Bot A2019
• Bot Insight A2019 on page 573

Enterprise A2019

To verify which  version is compatible with this release, see Compatibility with release builds on page 1026.

Nuove funzionalità

Migration from Enterprise 11 and Enterprise 10 to Enterprise A2019 (currently available
only to those in the Migration Early Adopter Program)
Enterprise A2019
Migration to Enterprise A2019 is currently only available to select customers through our Migration
Early Adopter Program. If you are interested in learning more about this program or a timeline
for when migration will be available to all customers, contact your Automation Anywhere
representative.
• Workload management data is automatically migrated to Enterprise A2019 when you install

Enterprise A2019 and point the Control Room to the restored Enterprise 11 database.
How workload management data is migrated on page 1199

• Version 11.3.1 and Version 11.3 are certified for migration to Enterprise A2019.
Migrazione a Automation 360 on page 1126

• Viene fornito supporto aggiuntivo per pacchetti e variabili.
Mappatura dei pacchetti per la migrazione on page 1247 | Mappatura delle variabili per la migrazione
on page 1279

• Migrate TaskBots and MetaBots created in Enterprise 10 to Enterprise A2019 using APIs.
Migration API

Bypass legal disclaimer
Enterprise A2019
When you allocate a device license to a user, the Bypass legal disclaimer option is automatically
enabled to allow the user to run bots on the device without having to manually acknowledge a
disclaimer.
Create a user on page 2684
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Nuove funzionalità

Choose to automatically update Bot Agent (Service Cloud case ID: 00497873)
Enterprise A2019 and Community Edition
An Control Room administrator can now choose to automatically update the Bot Agent to a later
version (Administration > Devices) using the auto-update capability. In the earlier version, each
Bot Agent had to be updated manually after logging in to a device, resulting in more downtime.

Note:  In this release, Bot Agent users have to update each Bot Agent manually. From subsequent
releases, the auto-update setting will be applied and each Bot Agent will be updated automatically.

• For Cloud and Community Edition, the auto-update option is enabled by default.
• For On-Premises, the default update option is set to manual.

Aggiornamento automatico di Bot Agent on page 1042

Universal Recorder new features
Enterprise A2019 and Community Edition
• The Universal Recorder can now capture objects in SAP versions 730, 740, and 760 patch 5.
• You can build automations in an SAP application using multiple connections (user accounts) and

several sessions per connection at one time.
• You can now record and run bots to capture objects from a Google Chrome browser that does

not have a zoom level setting of 100%.

Capture active text, passive text, image button, and scroll in combo box in AISense
Recorder
Enterprise A2019
You can now capture active text, passive text, image button, and scroll in a combo box from a
remote application when recording a task with AISense Recorder.
Record a task with AISense Recorder on page 1966

New Database package features (Service Cloud case ID: 00537047)
Enterprise A2019 and Community Edition
• The Connect action now enables you to connect to an Excel database.
• Use the Export to data table action to retrieve records from the database and store the

retrieved data in a table variable.
• You can now store the output of the Run stored procedure action in a dictionary variable.

Utilizzo dell'action Connetti per il database on page 1451 | Using the Export to data table action on page
1462 | Using the Run stored procedure action on page 1458

New Active Directory package available
Enterprise A2019 and Community Edition
Use actions from the Active Directory package to manage users across a group or organization. You
can perform operations such as create, modify, and delete users, groups, or organizational units
with centralized control.
Active Directory package on page 1378
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Nuove funzionalità

Log in securely when connecting to Active Directory server
Enterprise A2019 and Community Edition
You can use the Connect action from the Active Directory to enter your credentials (username and
password). You can either insert the credentials from the Credential Vault or insert a variable that
holds a credential type value.
Using Connect action for Active Directory on page 1383 | Credentials and credential variables in the Bot
editor on page 2039 | Le tue variabili (definite dall'utente) on page 2026

Support for Excel cell formats, including Number, Percentage, Currency, Scientific, and
Date
Enterprise A2019 and Community Edition
Use the Get single cell and Get multiple cell actions from the Excel basic package and the For
each row in worksheet Loop iterator to retrieve values in the format set in the Excel worksheet.
For example, a value from a cell of Currency formatting retains the currency symbol when passed
to a table or record variable.
Excel basic package on page 1527 | Loop package on page 1681

Automate a task on a range of cells in an Excel worksheet
Enterprise A2019 and Community Edition
Specify a cell range in the Delete cells action to perform the operation on the cells in the range.
Excel advanced cell operations

New PDF package action
Enterprise A2019 and Community Edition
Merge multiple PDF files into a single PDF file using the Merge documents action.
Using the Merge documents action on page 1738

Support for Czech and United States 2 code pages in Terminal Emulator package
Enterprise A2019 and Community Edition
The TN3270E and TN5250E terminal types support the Czech and United States 2 code pages. Use
the Connect action to select the terminal type and code page.
Using Connect action for Terminal Emulator on page 1903

Proxy support for packages
Enterprise A2019
If a device is configured with a proxy, all outbound requests from the following packages are routed
through the proxy server:
• Recorder
• REST Web Service
• SOAP Web Service
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Nuove funzionalità

Form builder enhancements
Enterprise A2019
Il generatore di moduli ora include i seguenti nuovi elementi:
• Dynamic - Enables dynamic rendering of the selected area.
• Snapshot - Enables you to take a snapshot of the form.

Enhancements to actions in Interactive forms
Enterprise A2019
• Enhanced highlight action

The Highlight action in the Interactive forms includes a Highlight type drop-down menu. You
can use Warning or Error to highlight the selected form element during the bot runtime.

• New Change label action
Use this action to change the label or title of the selected element of a specific form.

• Dynamic area action
• The Add row in Dynamic area action enables you to append or overwrite a dynamic

element of a form.
• The Clear action enables you to remove the dynamic elements.

Interactive forms package on page 1638

Retrieve trigger event data
Enterprise A2019
You can now retrieve the trigger event data during bot runtime by defining a variable as the input
type.
Add a file and folder trigger on page 2211

Record variable support for schema
Enterprise A2019 and Community Edition
You can create a new record variable with a schema to set the order of the fields and the type of
data that can be entered into each field.
Variabile record on page 2035

Product interface now available in Russian language
Enterprise A2019
Enterprise A2019 is now available in Russian.
Internazionalizzazione, localizzazione e supporto linguistico on page 870
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Nuove funzionalità

Clone and view content in Control Room
Enterprise A2019
The Control Room now includes the following new permissions:
• View content: This permission allows you to view the contents of a cloned bot. This permission

applies to both public and private workspaces.
• Clone: This permission allows you to create a read-only copy of the bot from the public

workspace. The same bot can be cloned by multiple users. This permission applies only to the
public workspace.

Bot permissions for a role on page 2706

New condition in the If and Loop packages
Enterprise A2019 and Community Edition
Use the Dictionary > Check key condition to execute actions based on whether the value of the
specified key is Equal to or Not equal to, or Contains or Does not contain the target value.
If package on page 1625 | Loop package on page 1681

New encoding type in CSV/TXT and Log To File packages
Enterprise A2019 and Community Edition
The UTF-16LE encoding option provides support for files that contain the byte order mark (BOM)
Unicode character. In the CSV/TEXT > Open action, selecting this option causes the BOM
character to be ignored when data is retrieved from the file using a subsequent Read or Loop
action. In the Log to file action, this option inserts a BOM character at the beginning of the file.
Utilizzo dell'action Apri per file CSV/TXT on page 1437 | Using Log to file action on page 1680

Retrieve a list of available users using Device API
Enterprise A2019
Use the Device API to identify all available users with unattended Bot Runner licenses, or to filter
for users by name. This API returns details of each user, including the user ID, username, and
device name.
Device API

Manually configure time interval value of database connection retries property (Service
Cloud case ID: 00573167)
Enterprise A2019 and Community Edition
You can manually configure the time interval value of the database connection retries in the
cluster.properties file. If the database is reconnected within the time specified in the
cluster.properties file, the Apache Ignite cache node in the cluster setup will not restart
the Apache Ignite server, keeping the device and the Control Room user connected. The default
value of the time property ignite.max.duration.db.connection.retries in the
cluster.properties file is 10000. The recommended maximum time for this property is up to 5
minutes (300000 msec).

Note:  Restart the Control Room services on each node for the manually configured value of the
time property to work effectively. Also, set the time in milliseconds.
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Nuove funzionalità

Run as user to default device mapping in Workload automation (Service Cloud case ID:
00563115)
Enterprise A2019 and Community Edition
Workload automation now allows one-to-one (1:1) mapping of the Run As user with default
devices when these devices are part of a device pool. Therefore, you can select default devices that
are mapped to a Bot Runner to avoid auto-login failures in environments where the security policy
does not allow a user to log in to any other device or devices.
Add queue, Bot Runner, and device pool on page 2810

Authentication proxy support
Support is now available for proxy authentication servers where any application going through the
proxy is authenticated and authorized before accessing the internet.

Pacchetti supportati

Pacchetto Versione

Gestione nodi 12.1.6000

Application 2.0.0-20200624-041608

App Integration 1.0.0-20200624-041607

Analizza 2.2.3-20200624-011702

Active Directory 2.0.1-20200624-041605

Boolean 2.0.0-20200624-041610

Migrazione bot 2.4.0-20200604-174031

Browser 2.0.0-20200624-041611

Clipboard 2.0.0-20200624-041619

Comment 2.0.0-20200624-041619

CSV/TXT 2.0.0-20200624-041620

Database 2.0.0-20200624-041623

Data Table 2.0.0-20200624-042148

Datetime 2.0.0-20200624-041628

Delay 2.1.0-20200624-041629

Dictionary 2.0.0-20200624-041629

Run DLL 2.0.0-20200630-062222

Email 2.0.0-20200624-041631

Error handler 2.0.0-20200624-041636

Excel basic 2.0.0-20200630-062144

Excel advanced 4.0.0-20200630-062063

File 2.1.0-20200624-041638
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Pacchetti supportati

Pacchetto Versione

File & folders 1.1.0-20200627-151822

Folder 2.1.0-20200624-041640

FTP / SFTP 2.0.0-20200624-041644

IF/ELSE 2.0.0-20200624-041646

Image Recognition 2.0.0-20200624-041747

Moduli interattivi 2.14.0-20200629-185534

IQ Bot 2.0.0-20200415-125005

JavaScript 2.0.0-20200630-062021

Simulate keystrokes 2.0.0-20200624-041915

Legacy Automation 2.0.0-20200624-041919
1.0.0-20200515-133334

List 2.0.0-20200624-041923

Log To File 2.0.0-20200624-041923

Loop 2.0.0-20200624-041924

Message Box 2.0.0-20200624-041925

Mouse 2.0.0-20200624-041929

Number 2.0.0-20200624-041934

OCR 2.1.0-20200630-062040

Office 365 Excel 2.0.0-20200630-062127

Office 365 Calendar 2.0.0-20200630-061819

Office 365 OneDrive 2.0.0-20200630-062133

PDF 2.1.0-20200624-042032

PGP 2.1.0-20200630-062139

Ping 2.0.0-20200624-042035

Stampante 2.0.0-20200624-042042

Play Sound 2.0.0-20200624-042037

Prompt 2.0.0-20200624-042043

Python Script 2.0.0-20200624-042044

Recorder 2.0.6-20200626-193519

REST Web Service 2.0.0-20200624-042128

SAP 2.1.0-20200624-042131

Screen 2.0.0-20200624-042134

SNMP 2.0.0-20200624-042137
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Pacchetti supportati

Pacchetto Versione

SOAP Web Service 3.0.0-20200624-042140

String 3.0.0-20200624-042145

System 2.0.0-20200624-042146

Attività 2.0.0-20200624-103759

Terminal Emulator 3.2.0-20200625-032209

Trigger Email 1.1.0-20200624-042201

VBScript 2.0.0-20200630-062305

Wait 3.0.0-20200624-042156

Window 2.0.0-20200624-042224

Workload 2.0.0-20200624-042158

XML 2.0.0-20200624-042200

Funzionalità modificate

Changes in the Database > Run stored procedure action
• It is now optional to enter an input or output parameter name.
• You must specify the data type of an input parameter. Choose from Boolean, date, number, or

string date type.

The terminal screen for ANSI and VT100 terminals now displays 24 rows, instead of 25 rows as in
earlier versions.

Email > Send action interface changes
For the Use secure connection (SSL/TLS) and My server requires authentication fields, you
must now select True or False, or insert a Boolean variable. Previously, the fields were activated
by selecting a check box.

Import bots in public or private workspace
Service Cloud case ID: 00456712
Users can now import bots into the public workspace if they have the required permissions,
regardless of their licenses. Additionally, users with a Bot Creator license can now import the bots
either into the public or private workspace.
Importa bots on page 2837

Problemi risolti

ID caso Service Cloud Descrizione

00554068 In the Community Edition, when you upgrade your Bot Agent
to a later compatible version, TaskBots created with system
variables of numeric type now run successfully. The Control
Room does not show a preprocessing error when you deploy the
TaskBots.
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Problemi risolti

ID caso Service Cloud Descrizione

00443421 The Run stored procedure action in the Database package
runs as expected with Oracle Database when you use input and
output parameters.

00557374 The Universal Recorder now consistently captures objects from
an SAP application and identifies the technology for those
objects as SAP when all prerequisites are met.

00611874 An error is no longer encountered when a variable containing
Japanese characters is used in the Write to file action of the
Data Table package.

00564534 A modified dependency file with the same name as the original
file and a new size is now successfully checked in from the
private to the public repository. The old file that was previously
checked in is no longer referenced after the modified file is
checked in to the public repository, thereby preventing a bot
execution failure.

00570537 When you clone a bot with or without dependency files, the
cloned bot now displays the actual file size for the bot and its
dependency files.

00577247, 00587976 Fixed an issue where the Email > Move all action did not
move emails when a bot ran the action on an OS configured
with the Japanese language setting.

00552729 The PGP > Decrypt action now works for PDF files.

00487805 You can now access the TN3270 terminal without the terminal
screen displaying all text with strike lines. Before using any type
of terminal to execute terminal commands, install the latest VC
++ package.
Latest supported Visual C++ downloads

00584051 Python 3 script now supports using Unicode characters in input
variables. Bot error messages are no longer displayed when
Python 3 is used to pass Japanese characters to a variable.

00540651, 00587963, 00593302 You can now use the Assign, Join, Merge, and Sort actions
from the Data Table package when you change the default
language from English to Simplified Chinese.
You can also use the Assign action when you change the
default language from English to Japanese, Korean, and other
non-English languages.

00577284 The Split document action in the PDF package now executes
correctly for a horizontal PDF file, and the large-width output file
is not cut off from the sides.

00595357 You can now export and import two different bots (with the
same name) in different folders from a staging environment into
a production environment.

00569527 You can now perform a check-in and check-out of bots with
dependencies.
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Problemi risolti

ID caso Service Cloud Descrizione

00574309 You can now update or remove Cluster ip addresses from the
Elastic search disaster recovery backup cluster setting
from the Control Room Administration page.

00525854 When a file type variable is used to open an Excel, CSV, or Java
script file, bots can now be executed successfully when the file
variable is used as an input.

00609184 After the existing license expires, the admin user can now
successfully install a new Control Room license for a Control
Room hosted on Linux CentOS.

00576202 You can now insert a user-defined string variable in a message
box display when the string variable is included in the
expression for multi-line values.

00560706 You can now view the actions menu (vertical ellipsis) to edit or
delete the variable string name when the character length is
more than 35 characters.

- For the Checkbox element, changes made to the check box
names in the Checkbox content field are now updated when
you enable Advance behaviors > Make default selections.

- You can now set the default selection in Advance behaviors
for the Radio button element in a form.

00557395 You can now check in bots that use the variable $prompt-
assignment$ without receiving an error message. Previously,
when you opened the bot in List view, an error icon was
displayed next to the actions that contain the variable.

00560356 Previously, when a task that consisted of one or more subtasks
was run, the In Progress entry for the task was moved into a
historical report with the completion of the first subtask, not the
entire governing task. Now, the In Progress tasks are not moved
to historical status until the completion of the entire task.

00556113 In Community Edition opened in Google Chrome, you can
now select the device icon in a non-English language, and the
[link] and [icon] tags are no longer displayed.

00559360 You can now re-import a bot that has failed previous imports.
The query did not return a unique result: 2
displayed during re-import attempts is now fixed.

00443590 Fixed an issue where after a bot is deployed on a Bot Runner
device, that device is in a different state compared to the state
before the bot deployment. For example, if a Bot Runner device
is locked before bot deployment, after it is unlocked to deploy
the bot, it will now be moved back to lock status.

00559507, 00594149 Support for scheduling bots with Internet Explorer version 11
is now improved. Users in the Control Room can scroll through
multiple pages of scheduled bots without issues with scrolling
through the interface.
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Limitazioni note

In Enterprise A2019 On-Premises, a security scan might report the Recorder package as malware
because the check.exe file is missing the root identification certificate.
You can contact Automation Anywhere Support to get an updated package with the signature fix
and upload it to your Control Room.
Add packages to the Control Room on page 2649

Version Enterprise 10 or Enterprise 11 bots containing commands that have white space in the
credential attributes cannot be migrated to Enterprise A2019. The migration process stores some
credential attributes in global values in Enterprise A2019. Global values do not support white
spaces.
To migrate bots that use credential attributes, you can remove the white spaces or replace them
with characters.

If you use the Get action for an empty dynamic element of a form, errors are displayed during bot
runtime.

If you use Trigger loop: Handle within a bot, link it to a form with Select File element, and set
the Select action trigger > Lost focus, the next event is not triggered when you click Browse.

The Set focus action in Interactive forms does not work when you use it to link the fields
between two different forms.

In the form builder screen, text is displayed in English even when you change the display to non-
English language.

You might see the schedule automation name instead of the Workload automation name in the
Workload > Queue > View Activity in progress and Run bot with queue > View pages
when Work Items are processed for automation in the Bot Agent. This occurs if the Workload
automation ID and schedule automation ID are the same in the Control Room database.

The Task bot > Run action only supports files selected from the Control Room repository. Also,
this action only supports file type variables with a set default value and the input option disabled.
You cannot modify the file variable value using the File > Assign action.

When you edit a bot using a previous package version (for example, an Enterprise A2019.13
version) and the Desktop session automatically starts, if you exit the Bot editor while the Desktop
session is trying to launch, the previous package version will be displayed when you open a
new Bot editor instance. However, you should see the Enterprise A2019.14 package version
associated with the new Bot editor instance. If you close and reopen the new Bot editor instance,
the Enterprise A2019.14 package version will be displayed.
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Limitazioni note

There is an issue for a specific, manually generated license key file supplied by Automation
Anywhere to upgrade from Enterprise A2109.13 to Enterprise A2019.14.
This issue applies only to customers who are in the following specific category (all must be true):
1. Control Room is at the customer premises
2. Control Room is running Enterprise A2019.13 or earlier
3. Installed a license file that was provided to them in July 2020 (not self-generated through the

customer self-service license portal)
4. User has upgraded the On-Premises Control Room to Enterprise A2019.14.

For this issue, contact Automation Anywhere for updated license files.

Important:  Users who self-generated their license files through the A-People License portal are
not affected by this issue. Cloud customers are also not affected by this issue.

A bot that contains the Capture action from the Recorder package fails when both the HTML
 InnerText and InnerHTML object properties are selected.
Soluzione: Select only one of the object properties.

The Universal Recorder fails to perform a click, set text, or append text action on the correct control
when a debug window or download bar is open. This occurs only in the Google Chrome browser
with the device display set to 100%.
Soluzione: Disable the Google Chrome download bar.

When you create, edit, or run a bot from the Bot editor window, close the Bot editor window when
the socket connection has just been established, and then navigate to the My bots page, the
Recorder window opens for a moment and then closes.

Known limitation

IQ Bot

The IQ Bot A2019 On-Premises version supports all the features and functionality available in IQ Bot
Version 11.3.4.2.
Matrice di confronto delle funzionalità per Automation 360 IQ Bot on page 735
Review the compatibility of the IQ Bot On-Premises version with the corresponding Control Room On-
Premises version.
Compatibilità delle versioni di Automation 360 IQ Bot on page 740
The IQ Bot A2019 Cloud version is available for this release and supports all features and functionality
available in IQ Bot Version 11.3.4.2. This version provides users with automatic provisioning for up to three
environments such as Development, Test, and Production. Users can migrate learning instances between
environments using APIs.
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Nuove funzionalità

Delete bot option in IQ Bot Designer (Service Cloud case ID: 00096258, 00595526)
IQ Bot On-Premises e Cloud
Users with Edit bot permission can view and use the Delete bot option in the Designer. After a
bot is deleted from the system, it will not be displayed in the Learning Instance or Bots listing
pages.
IQ Bot removes all document details from staging, and all unprocessed production documents are
moved to the Validator.

Note:  The Migration Utility > Import/Export functionality is not affected in any way by the
Delete bot feature.

Bots

Extract data from a table that spans across multiple pages (Service Cloud case ID:
00371795)
IQ Bot On-Premises e Cloud
IQ Bot can now extract data successfully from an entire table that spans across multiple pages and
has a table header only on the first page.

Add fields and field alias to custom domain (Service Cloud case ID: 00471075)
IQ Bot On-Premises e Cloud
You can now add additional fields (form or table) and field aliases to a custom domain for an
existing learning instance.

Alert for successful or pending document validations
IQ Bot On-Premises e Cloud
Document validation status is now displayed on the Learning instances page. A green icon is
used for all successful document validations, and a red icon shows any pending validations.

Funzionalità modificate

Import custom domains from the staging to the production server in any order (Service
Cloud case ID 00472445)
You can now edit and update an existing custom domain multiple times and import them to the
production server multiple times, and in any order, before importing the learning instances. After
importing the learning instances, the system classifies all documents in the production server
correctly, allowing for successful processing of documents.
Custom domains in IQ Bot

© 2023 Automation Anywhere. All rights reserved.     571



    Automation Anywhere - Learn

Funzionalità modificate

Validator enhancements (Service Cloud case ID: 00470258)
Some of the Validator enhancements are as follows:
• You can now hide the Skip to next file and Mark as Invalid options using configuration

settings. The options are currently enabled by default.
To enable the option to hide them, contact Automation Anywhere Support.

• You can now hide the Hide successful fields and Hide optional fields options using
configuration settings. The options are enabled by default.
To enable the option to hide them, contact Automation Anywhere Support.

Note:  Selecting the Hide successful fields and Hide optional fields check boxes hides
all the valid fields and reduces the display of a large number of fields, thus making correction
easier. However, if there is an invalid field, it continues to be displayed because the invalid field
requires correction.

• Clicking in any column field expands the column width to accommodate the text entry. The
Validator shows the value of the field that is being validated, in the document.

• Draw an area around single or multiple values in the document image to automatically populate
a field in the Validator. This function is similar to the Designer.

Problemi risolti

ID caso Service Cloud Descrizione

00552830 You can now use the unique validation link to access the
documents without any errors.

- When you use table extraction from a document with multiple
tables, the data from the specified table is now extracted
correctly.

00551886 Unicode issue with table validation for Asian languages is now
resolved.

00538480 The Options method is now disabled for HTTP requests.

00538480 Cross origin resource sharing is now restricted in IQ Bot.

00421067 The activities time stamp is now captured correctly in the Control
Room Audit Logs tab.

00522817 The TestRun output of a custom logic now displays the
characters without any distortion, irrespective of the language
you select.

00605420, 00605741, 00606561 After upgrading to IQ Bot Cloud if you restart the Control Room,
you can now view or create learning instances immediately
without restarting the IQ Bot service.
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Limitazioni note

IQ Bot On-Premises e Cloud
If you create a learning instance and click Learning instances > Edit, a blank page is displayed.
Soluzione: Clear your browser cache and try to edit the learning instances.

IQ Bot On-Premises e Cloud
If you log in to the Control Room as an IQ Bot administrator, a 502 system error is displayed
when you click the IQ Bot tab in the navigation bar.

IQ Bot On-Premises e Cloud
You can view the ValidatorURL error message for a validated document along with the corrected
field in the .csv output file.

IQ Bot On-Premises e Cloud
In Internet Explorer, you cannot save a document or mark it as invalid in the learning instances
validator screen.
Soluzione: Use the Google Chrome browser to access the learning instances validator screen.

IQ Bot Community Edition
If you remove a bot (Delete a bot) associated with the document from the staging environment,
you must create a group before uploading this document to the production environment. However,
after deleting the bot from the staging environment, you cannot create or edit the group when you
upload the same document to the production environment.

Bot Insight A2019

Nuove funzionalità

Line Bar Chart widget available
Enterprise A2019
The Line Bar Chart widget enables you to view and analyze information about your metrics and
attributes. You can input two metrics and one attribute and display a bar graph when only one
attribute is selected or display a clustered graph when two or more attributes are selected. You can
use Date types as interval options, grouped by Day, Week, Month, and Year.
Bot Insight visualizations on page 2976

Advanced settings for a query
Enterprise A2019
You can use the Advanced Settings option to configure more of your queries when you create a
new widget. You can now set limits to your attribute values as grouped by 10, 20, 50, and 100
values. You can also sort your data by ascending or descending order.
Configuring a Line Bar Chart query on page 2977
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Note su Enterprise Edition A2019.13

Data di rilascio: 15 June 2020

Review the new features, supported packages, changed features, fixed features, and known limitations in
the Enterprise A2019.13 release. There are no security fixes in this release.
A2019.13 Build 4701 is available for Cloud customers, and Build 4705 is available for On-Premises
customers. Community Edition remains on A2019.12 and will be upgraded to A2019.14 upon availability.
• Enterprise A2019
• IQ Bot on page 582
• Bot Insight on page 585

Enterprise A2019

To verify which  version is compatible with this release, see Compatibility with release builds on page 1026.

Nuove funzionalità

Migration from Enterprise 11 and Enterprise 10 to Enterprise A2019 (currently available
only to those in the Migration Early Adopter Program)
Migration to Enterprise A2019 is currently only available to select customers through our Migration
Early Adopter Program. If you are interested in learning more about this program or a timeline
for when migration will be available to all customers, contact your Automation Anywhere
representative.
• The Insert work item command, workload management queues, and device pools are now

migrated to Enterprise A2019.
• Schedules are migrated when you copy Enterprise 10 data to Enterprise A2019 or update

Enterprise 11 data to Enterprise A2019. You then have to remap some dependencies to enable
the migrated schedules.
Abilita le pianificazioni dopo la migrazione on page 1242

• Viene fornito supporto aggiuntivo per pacchetti e variabili.
Mappatura dei pacchetti per la migrazione on page 1247 | Mappatura delle variabili per la migrazione
on page 1279

Record tasks with a device display setting of 125% or 150%
You can now record tasks using Universal Recorder in Java, Microsoft Active Accessibility, and
Microsoft UI automation applications on a computer that has a device display setting configured at
125% or 150%, in addition to the existing setting of 100%.

Export bots without enabling SMTP in Bot Lifecycle Management
When you export a bot, you can now download the exported package even when SMTP is not
enabled. The link to download the exported package is available in the ACTIVITY > Historical
page.
Esporta bots on page 2835
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Nuove funzionalità

Export and import files using Bot Lifecycle Management APIs
Use the Bot Lifecycle Management export and import APIs to move bots from one environment to
another based on your organization's automation requirements.
You can export bots with dependent files and command packages from the public workspace of one
Control Room and import them to a private workspace in another Control Room, and check them
into a public workspace. To export and import bots, you must have the Export bots, Import bots,
View and Manage packages, and Check in and Check out permissions to the necessary folders and
have the Bot Creator license.
BLM API

Capture scroll action and table using AISense Recorder
You can now capture the scroll action in an application window and table control from a remote
application when recording a task with AISense Recorder.
Record a task with AISense Recorder on page 1966

Form builder enhancements for interactive forms
The form builder includes the following elements:
• Select File: To enable file upload in the form.
• Elenco a discesa: To create a drop-down menu in the form.

Create a form on page 2186

Extract text from a specific area in a window
Use the App Integration > Capture area action to extract text from within the captured area of
a window and save it to a string variable.
App Integration package on page 1398

Read string variable values from a text file
Use the String > Import string from text file action to read values from a text file and save
them to a string variable.
String package on page 1881

Automate in IBM-5555 terminals using the Terminal Emulator package
The TN5250E terminal type now supports the IBM-5555-C01 and D01 terminal models.
Terminal Emulator package on page 1902

Specify events within email trigger
For email triggers, specify an event within the server type (Outlook, Email, or EWS server) to
trigger a bot.
Add an email trigger on page 2208

Use hot key for interface trigger
For interface triggers, you can select hot key as one of the conditions to trigger the bot
Add an interface trigger on page 2213
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Nuove funzionalità

Assign action in interactive forms package
The interactive forms package now includes an Assign action that you can use to assign values
dynamically in the Dropdown element of a form.
Interactive forms package on page 1638

Create a shortcut of a file or folder
Use the Folder > Create shortcut or File > Create shortcut action to create a shortcut in the
specified destination file path. The shortcut is dependent on the source file or folder. If you make
changes to the source file or folder, the changes will also apply to the shortcut.
File package on page 1562 | Folder package on page 1571

New conditions in the If and Loop packages
• Use the Data table > Data table is empty condition to execute actions based on whether the

specified table contains values.
• Use the Data table > Number of columns and Data table > Number of rows conditions

to execute actions based on whether the number of columns or rows is Equal to, Greater
than, or Less than the specified value.

If package on page 1625 | Loop package on page 1681

Generate a random string of a user-specified number of characters and assign it to a
string variable
Use the String > Random action to generate a string of uppercase and lowercase alphanumeric
characters. You can specify the number of characters that the generated string consists of, with a
maximum of 300 characters.
String package on page 1881

Upgrading Enterprise A2019 enables pre-filling installation parameters
If you are upgrading from one Enterprise A2019 version to another, you have the option to pre-
fill the installation parameters with existing installation content. Existing installation parameters
include, for example, the installation path, HTTPS ports, database names, IP addresses, and TLS
configuration. The username and password have to be manually entered.
Note that this is applicable only to a Windows-based installation.
Run Control Room installer on page 904 | Installing Control Room on Linux on page 948

Pacchetti supportati

Pacchetto Versione

Gestione nodi 7.1.5207

Application 2.0.0-20200515-071407

Integrazione app 1.0.0-20200515-071406

Analizza 2.2.2-20200515-101604

Boolean 2.0.0-20200515-071408

Migrazione bot 2.4.0-20200604-174031
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Pacchetti supportati

Pacchetto Versione

Browser 2.0.0-20200515-071410

Clipboard 2.0.0-20200515-071418

Comment 2.0.0-20200515-071418

CSV/TXT 2.0.0-20200515-071419

Database 2.0.0-20200515-071421

Data Table 2.0.0-20200515-071731

Datetime 2.0.0-20200515-071424

Delay 2.1.0-20200515-071425

Dictionary 2.0.0-20200418-005349

Run DLL 2.0.0-20200515-071713

Email 2.0.0-20200515-071427

Error handler 2.0.0-20200515-071432

Excel basic 2.0.0-20200515-071623

Excel advanced 4.0.0-20200604-173722

File 2.1.0-20200515-071434

File & folders 2.0.0-20200317-030352

Folder 2.1.0-20200515-071436

FTP / SFTP 2.0.0-20200515-071439

IF/ELSE 2.0.0-20200515-071441

Image Recognition 2.0.0-20200515-071454

Moduli interattivi 2.12.0-20200420-084203

IQ Bot 2.0.0-20191031-150538

JavaScript 2.0.0-20200515-071459

Simulate keystrokes 2.0.0-20200515-071502

Legacy Automation 2.0.0-20200515-133330
1.0.0-20200515-133334

List 2.0.0-20200515-071509

Log To File 2.0.0-20200515-071509

Loop 2.0.0-20200515-071511

Message Box 2.0.0-20200515-071511

Mouse 2.0.0-20200515-071517

Number 2.0.0-20200515-071522

OCR 2.1.0-20200516-083309
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Pacchetti supportati

Pacchetto Versione

Office 365 Excel 2.0.0-20200515-071608

Office 365 Calendar 2.0.0-20200515-071414

Office 365 OneDrive 2.0.0-20200515-071614

PDF 2.1.0-20200515-071618

PGP 2.1.0-20200515-071620

Ping 2.0.0-20200515-071621

Stampante 2.0.0-20200515-071626

Play Sound 2.0.0-20200515-071622

Prompt 2.0.0-20200515-071627

Python Script 2.0.0-20200515-071628

Recorder 2.0.5-20200523-020302

REST Web Service 2.0.0-20200515-071712

SAP 2.1.0-20200515-071715

Screen 2.0.0-20200515-071718

SNMP 2.0.0-20200515-071720

SOAP Web Service 3.0.0-20200515-071723

String 3.0.0-20200515-071729

System 2.0.0-20200515-071729

Attività 2.0.0-20200519-082744

Terminal Emulator 2.0.0-20200515-071735

Trigger Email 1.1.0-20200515-022805

VBScript 2.0.0-20200515-071737

Wait 3.0.0-20200515-071739

Window 2.0.0-20200515-071753

Workload 2.0.0-20200422-054201

XML 2.0.0-20200515-071743

Funzionalità modificate

The Dictionary > Put action is now the Dictionary > Set value action. When you provide the
key name, if the key does not already exist, this action creates a new key-value pair. In addition,
you can now manually enter a value; previously, you had to select from a list of variables.

In the Excel advanced > Get worksheet as data table action, the Tick if the first row is the
header option is now the Sheet contains header option. There is no change in functionality.

© 2023 Automation Anywhere. All rights reserved.     578



    Automation Anywhere - Learn

Funzionalità modificate

The File > Rename and Folder > Rename actions now accept the full file path in the New file
name and New folder name fields. Previously, these fields only accepted the new file or folder
name.

When you select a file from the desktop for the JavaScript, Python Script, or VBScript packages, it is
no longer necessary to isolate that file in a separate folder. Previously, when you selected a file with
the Open action, all the files in that folder were selected too.

The Database > Run stored procedure action now has a different interface that enables you
to configure input parameter values and output parameter data types. This action is not backward-
compatible because the user interface controls and input data type have changed. You must modify
the Run stored procedure action fields in the bots that contain previous versions of this action.

The Cloud License feature is now enabled by default in the Control Room.

Problemi risolti

ID caso Service Cloud Descrizione

00492377, 00511639 Bots using the Image Recognition action can now recreate the
recorded activity and run successfully.

00599586, 00600149, 00601142,
00599483

The Processing failure error encountered when using the
Wait for condition action is now fixed. Bots using this action
now run successfully.

00583248 During Work Item consumption, a running task is no longer
canceled when the next bot is deployed.

00548456 The Workload Management v3 APIs are now successfully
executed in Swagger and do not fail because of a case-sensitive
issue.

00601083 For Cloud deployment, users can now successfully export bot
files and download them without any errors.

00568664 The Git integration option is now displayed for admin users
when they navigate to ADMINISTRATION > Settings in the
Control Room.

-- The minimum length value of a form element cannot be 0. If
you set the value as 0 in Character limit > Min field, the
Make field required is disabled.

00571125 When you check in a non-bot file by itself, the file is now
checked in without any error. Older files that exist in Build 4111
are also unlocked and checked in after upgrading to Build 4705.

-- The form preview feature is now consistent across the Internet
Explorer and Google Chrome browsers.

-- A blank page is no longer displayed when you paste content
into any of the existing form elements on the form builder.

-- A form that is linked to a bot through the Display action of
interactive forms is now displayed in front of all other windows
when the Always display form window in front option is
selected.
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Problemi risolti

ID caso Service Cloud Descrizione

-- When a user login failed due to a Global Catalog (GC)
availability issue, the response only indicated a communication
error. The process now checks for errors and exceptions in
the GC and processes the authentication with appropriate
messages, so users can take appropriate action.

00520394 The VBScript package actions now support Unicode characters.

00536881 When you delete a bot, any trigger that is associated with it is
also deleted and is not listed in the Activity list page.

00506169 You can now use the interface trigger to run a bot without any
errors in the Japanese operating system.

00537640, 00538369 When you check out a bot from the Control Room and add a
trigger, you can now use Run with triggers to run this bot
without any errors.

00531912 JavaScript package actions can now be used to parse the values
in a list.

00475183 Double-byte characters returned unreadable ANSI characters
in the bot Log To File text. This issue is now fixed and ANSI
encoding takes the system default charset.

00475129 You can now use double-byte characters in a variable name.

00511675 The Excel advanced > Find action now searches for values in
merged cells when the By rows search option is used.

00468103, 00475142 Bot names using Unicode characters, such as German umlaut,
Japanese characters, and others, display correctly in the pop-up
window at runtime.

00552701, 00558919 You can now select multiple actions from the Bot editor and
drag them into a Step, Loop, or If action.

00507240 Fixed an issue where a running parent bot could not be stopped
after it ran a child bot. Now you can stop a bot at any time.

00482810 VBScript actions can now run scripts that contain Unicode
characters.

00472684, 00541922,
00551632,00534508, 00570602

The Email > Send action now supports a user-input port
number for sending emails from an SMTP server, such as AWS
Simple Email Service. Previously, the action only used port 25,
even if the user entered a different port number.

00475230 Fixed an issue where the String > Replace action did not
support an empty string in the Replace with field. You can
now use the action to replace a specific string with an empty
string.

00472665 When a child bot shows an error, the parent bot now handles
the exception by running the Error Handler > Catch action.
Previously, the parent bot was also showing an error, even when
it contained Error handler actions.
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Problemi risolti

ID caso Service Cloud Descrizione

00566476, 00560339 Fixed an issue where bots that contain the Capture action
stopped working when running the action during deployment,
or they could not be checked out after they were checked-in for
editing.

00537139 A bot running the Capture action can now capture specific
objects from a Google Chrome browser on a device running the
Windows 10 operating system. In some cases, bots running the
Capture action from Version A2019.11 On-Premises could only
capture the entire browser window.

00421864 The Create a bot screen now displays properly in Internet
Explorer. Previously, some display issues occurred where the
screen was cut on the right side and the screen could not be
moved.

00584341 Fixed an issue where some of the historical activity entries were
incorrectly displayed. These entries are now displayed correctly
when a user drills down for more information.

Limitazioni note

When you create a Dictionary/Table variable and use it in the name field of the PROPERTIES
control, the bot does not deploy successfully. This issue occurs because Dictionary/Table variables
are not supported for the name field in the PROPERTIES control. You can pull the name value into
a String or Number variable before using it in the PROPEPTIES control, and then use that String or
Number variable in it.

You can use Swagger to export bots but not to download exported bots. You have to use the REST
Client to download exported bots.

When you run a bot, the runtime window is minimized after you preset the desktop.

The OSS Disclosure report provided in the A2019 installer is outdated. Starting from this release,
you can log in to Automation Anywhere Support site and download the updated report:
A-People Downloads page (Login required).

When you capture a table control from an application using the AISense Recorder, you cannot set
text using the Set text option from the Actions list. You can set text in the table by capturing a
cell from the table as a text box and then using the Set text option from the Actions list.

When upgrading from one Enterprise A2019 version to another, you have the option to pre-fill the
installation parameters with existing installation content, but only if you used the default installation
path C:\Program Files.

Note:  This is applicable only to a Windows-based installation.

Based on the permission assigned by an administrator, users can only view the Public tab that lists
the available forms and bots. However, users can edit an available form or bot by replacing View
with Edit in the Control Room URL.

When you create a bot and link a form to it, the bot is included only when you check in the form; it
is not available on form check-out.
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Limitazioni note

When you click multiple icons (Copy, Cut, and Paste) at the top of the form builder or bot creator
page, the tooltips overlap.

Issues in the form builder:
• If you drag any form element into a specific position on the form builder, it always appears at

the bottom of the available elements.
• If you drag form elements around in the form builder screen in Internet Explorer, the mouse

pointer flickers continuously.
• For the Radio button element, you cannot set the default selection in Advance behaviors.
• For the Checkbox element, changes made to the check box names in the Checkbox content

field are not updated when you enable Advance behaviors > Make default selections.

When a bot runs Terminal Emulator package actions in an IBM-5555 terminal, the terminal window
does not display double-byte characters, including Chinese and Japanese characters.

If you used the Universal Recorder to capture a menu item from a Microsoft Active Accessibility
application on a computer that has a display scale setting configured to 100%, at runtime the bot
does not click the correct menu item on a computer that has a display scale setting configured to
125% or 150%.

During GUID provisioning, License Sync is called internally after a successful installation. If the
internal License Sync fails but the installation is successful, users can log in and continue to work.

When a task that consists of one or more subtasks is run, the In Progress entry for the task is
placed into a historical report upon completion of the first subtask, not the entire governing task.

An error occurs if the parent bot contains actions for objects captured using the AISense Recorder
and the child bot contains actions for objects captured using the Universal Recorder, or vice versa.

IQ Bot

The IQ Bot On-Premises version supports all the features and functionality available in IQ Bot Version
11.3.4.2.
Matrice di confronto delle funzionalità per Automation 360 IQ Bot on page 735
Review the compatibility of the IQ Bot On-Premises version with the corresponding Control Room On-
Premises version.
Compatibilità delle versioni di Automation 360 IQ Bot on page 740
The IQ Bot Cloud version is available for this release and supports all features and functionality available
in IQ Bot Version 11.3.4.2. This version provides users with automatic provisioning for up to three
environments such as Development, Test, and Production. Users can migrate learning instances between
environments using APIs.
For the Custom Logic feature, there is an identified list of Python libraries and packages that are safe
to use for IQ Bot Cloud. Use only these packages to ensure security for your cloud infrastructure, file
systems, databases, and network resources.
List of Pandas Libraries which are supported and not supported on Automation 360 IQ Bot (A-People login required)
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Nuove funzionalità

Migrate data to a unified database
IQ Bot On-Premises e Cloud
The Database Migration Assistant enables you to migrate data from IQ Bot Version 6.5 or later
databases to a unified database in IQ Bot A2019.
Migrazione delle versioni precedenti di IQ Bot a Automation 360 IQ Bot On-Premises on page 1344

Support for custom validation Python scripts
IQ Bot Cloud
You can use custom logic in Python to modify intermediate extracted data in IQ Bot.
Add custom logic in IQ Bot to improve extraction

Select an OCR engine when creating a learning instance
IQ Bot On-Premises e Cloud
You can select different OCR engines directly from the UI based on your requirements for data
extraction from specific document types, when creating a new learning instance. You do not have to
stop and restart IQ Bot services for implementing the engine change.
Select an OCR engine

Enable or disable PDFBox option
IQ Bot On-Premises e Cloud
You can enable or disable the My PDF documents do not have images check box directly in the
UI when creating a learning instance.
Disable PDFBox option

Changed feature

The draw box icon for document values is no longer available. However, you can still click and drag
a box on the document to draw boxes for the labels along with the values.

Problemi risolti

ID caso Service Cloud Descrizione

-- A new REST API is now available that contains the IQ Bot
validator URLs of all the available documents that are not locked
by any users. A validator URL retrieved from the REST API can
be used in any browser to navigate directly to that specific
document.

00343034 You are now redirected to a specific document using the validator
URL after a successful login.

00471068, 00339407 The draw box functionality for field labels now ensures that the
selected value is treated as an entire word rather than distinct
characters. You can now select multiple system identified regions
(SIRs) or a specific part of a single SIR from a field label, which
enables accurate data extraction.
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Problemi risolti

ID caso Service Cloud Descrizione

-- The PDF Box feature now enables you to generate an SIR for a
PDF file that contains content in multiple formats.

00481720 The Service account user password can now include special
characters. The service account will not be locked and all the
IQ Bot services will start successfully after an installation,
irrespective of whether the password has special characters.

00510286, 00548393 When the Automation Anywhere Cognitive Application service
restarts after installing IQ Bot Build 4705, the user login
information is now captured without any duplication.
However, if you upgrade from any earlier version of IQ Bot to IQ
Bot A2019.13 (Build 4705), you must deregister and register IQ
Bot services.

00522978 When you now install IQ Bot, the user account is not locked even
when the password has special characters, and all the IQ Bot
services start without any issues.

00581425, 00581949,
00604394, 00602630

You can now register IQ Bot with child tenant using API, which
enables you to view all the available domains and learning
instances.

00575939, 00417631, 00423076 The .csv file is now displayed in the Output folder when
you upload a document with a long filename (more than 60
characters) using IQ Bot Upload.

Limitazioni note

IQ Bot On-Premises
The OSS Disclosure report provided in the IQ Bot A2019 installer is outdated. Starting from this
release, you can go to Automation Anywhere support site to download the updated report:
A-People Downloads page (Login required).

IQ Bot On-Premises e Cloud
Images on the Designer in IQ Bot appear distorted while scrolling in Internet Explorer.

IQ Bot On-Premises e Cloud
Installation errors are displayed for the Database Migration Assistant.
Soluzione: Install the MsSqlCmdLnUtils utility and Microsoft OCDB Driver 17 for SQL
Server before installing the Database Migration Assistant.

IQ Bot On-Premises e Cloud
Logs are not captured if the Database Migration Assistant installation fails.

IQ Bot Cloud
System suggestions are not updated when documents are validated by the user.
Soluzione: Users must update the correction manually in the validator for IQ Bot Cloud if the
system suggestions are not displayed.
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Limitazioni note

IQ Bot Community Edition
The Create new learning instance page refreshes automatically, which causes the user to lose
data from the General information fields.

(ID caso Service Cloud: 00737991)
When you are creating a learning instance and training your document, IQ Bot system cannot
extract data from tables with the same Header Name and Column Value.
Soluzione: Try combining Header Name or Column Value with the adjacent column.
Additionally, you can provide a Python postprocessing script to separate the values during
extraction.

Bot Insight

Nuove funzionalità

Compare mode widget filter
The Bot Insight compare mode introduces widget filters that you can apply to your existing
dashboards. A new Filter option shows a Filter window with the Attributes, Numeric, and Time
widgets.
Comparing dashboards on page 2969

Hourly support for widgets
The Bot Insight widgets include an Hour interval option in the Group By field for Date type. The
analytics for this widget groups your data by hourly intervals and displays the chart accordingly.
Using widgets on page 2975

Funzionalità modificate

Power BI connector
You can access the AABotInsightV3.mez data connector file from C:\Program Files
\Automation Anywhere\Enterprise\Connectors\PowerBI and copy it to C:\Users
\<your user>\Documents\PowerBI Desktop\Custom Connectors to deploy the Power BI
connector.
Deploy Power BI connector on page 2981

Bot Insight APIs
• All of the parameters are now optional.
• The botname parameter in the Get task log data API supports multiple bot names,

separated with a comma.
• There are no time period limitations now on the data retrieved.

Bot Insight API
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Note su Enterprise Edition A2019.12

Data di rilascio: 18 May 2020

Review the new features, supported packages, changed features, fixed features, and known limitations in
the Enterprise A2019.12 (Build 4111) release. IQ Bot Build 4088 is compatible with Enterprise A2019.12
Build 4111. There are no security fixes in this release.
• Enterprise A2019
• IQ Bot A2019
• Bot Insight A2019

Enterprise A2019

Important:  This release includes a required update to your . Ensure that you complete the update to
continue with your automation activities when upgrading from a previous release to this release.
Aggiornamento automatico di Bot Agent on page 1042 | Aggiornamento manuale del Bot Agent on page 1043

To verify which  version is compatible with this release, see Compatibility with release builds on page 1026.

Nuove funzionalità

Migration from Enterprise 11 and Enterprise 10 TaskBots and MetaBots to Enterprise
A2019 (currently available only to those in the Migration Early Adopter Program)
Enterprise A2019
Migration to Enterprise A2019 is currently only available to select customers through our
Migration Early Adopter Program. If you are interested in learning more about this program and
requirements, contact your Automation Anywhere representative.
• Migrate TaskBots and MetaBots created in Enterprise 10 to Enterprise A2019.

Migrazione dei bots di Enterprise on page 1216
• The summary report generated by the Bot Scanner now provides information about the number

of bots that can or cannot be migrated to Enterprise A2019.
Analisi del report di Bot Scanner per la migrazione on page 1162

• (Enterprise 11 only) Additional support is provided for packages and variables.
Mappatura dei pacchetti per la migrazione on page 1247 | Mappatura delle variabili per la migrazione
on page 1279

• (Enterprise 11 only) Migration APIs enable you to migrate a single Enterprise 11 bot or entire
folders of bots to Enterprise A2019. Use the Repository Management API to identify bots and
folders for migration.
Migration API  | Repository Management API
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Nuove funzionalità

Integrate Control Room with a remote Git repository
Enterprise A2019
Integrate the Control Room with remote Git repositories to manage bot version controls, and back
up and restore bots and the dependent files. The integration ensures one-to-one mapping of bots
between the Control Room and the remote Git file structure. When you perform a bot check-in, a
Git commit is performed at the remote Git host.
Integrating Control Room with Git repositories on page 2753

Additional actions in the Interactive forms package
Enterprise A2019 and Community Edition
The Interactive forms package includes the following actions:
• Set focus: Sets the focus on the selected form element.
• Highlight: Highlights the selected element of a form.
• Unhighlight: Removes the highlight from the selected element of a form.

Interactive forms package on page 1638

Form builder enhancements for interactive forms
Enterprise A2019 and Community Edition
The form builder includes the following elements:
• Document: Use this element to render an image (.jpg) or PDF file along with the form.
• Password: Use this element for a field that requires masking of the input data.

Create a form on page 2186

Run Task Bot option for attended Bot Runner (Service Cloud case ID: 00453797)
Enterprise A2019 and Community Edition
If the default device is mapped to the Bot Agent, a user with an attended Bot Runner license in the
Control Room can now use the Run Task Bot option from the bot context menu (vertical ellipsis)
to run the bot.
Considerations for running a bot on page 1995

New features in Universal Recorder and actions that use the recorder feature
Enterprise A2019 and Community Edition
• La modalità di registrazione sicura assicura che nei bots non siano archiviati i dati sensibili. When

secure recording mode is enabled, the bots do not capture application images or values.
Actions in the Image Recognition, Mouse, OCR, Screen, and Recorder packages support this
feature.

• JRE 6 is supported on both 32-bit and 64-bit systems.
• After you capture an object, you are returned to the window containing the Bot editor.

Actions in the Image Recognition, Mouse, OCR, Screen, and Recorder packages support this
feature.

Recording tasks in applications that run on JRE on page 1965 | Secure recording mode on page 1964
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Nuove funzionalità

Insert a work item action
Enterprise A2019 and Community Edition
The Insert work item action provides you the flexibility to insert a work item from an existing queue
to another queue as part of the bot execution. You can orchestrate multiple bots, enabling optimal
device utilization through the queueing mechanism of workload management.
Workload package on page 1937

View error details of a work item
Enterprise A2019 and Community Edition
You can view the reason for a workload automation failure in the new Error section on the View
work item details page.
View work items on page 2825

Extract text from windows
Enterprise A2019 and Community Edition
Use the Capture text of window action to extract text from a window and save it to a string
variable. You can capture text from UNIX shells and Windows applications.
App Integration package on page 1398

Store string values securely in a credential variable
Enterprise A2019 and Community Edition
Configure a credential variable to hold a user-provided value or a credential from the Credential
Vault. A credential variable cannot be converted to another data type, and the value cannot be
displayed in a message box or written to a file.
User-defined variables: Credential

Preload packages for improved bot performance
Enterprise A2019 and Community Edition
Preload packages on your local device to shorten the bot runtime. When you preload packages
used in a bot, the system skips the package download process at bot runtime, thereby improving
the bot performance.
Preload packages on page 2004

New features in the If and Loop packages
Enterprise A2019 and Community Edition
• Execute actions based on whether the value of the source datetime variable is Equal to or Not

Equal to, or is Greater than or Equal to, or is Lesser than or Equal to the value of the
target datetime variable.

• Execute actions on migrated bots based on whether Web control exists or is active.
• Configure a Loop action with multiple conditions.

Specify whether all or either of the conditions must be met.

If package on page 1625 | Loop package on page 1681
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Nuove funzionalità

Run a bot by inserting a file variable in the Run action
Enterprise A2019 and Community Edition
The Task Bot > Run action now supports a file variable input in the Task Bot to run field.

Configure a table variable using the Assign action in Data Table package
Enterprise A2019 and Community Edition
You can use this action to manually enter values, assign column names, specify the column data
type (string, number, datetime, or Boolean), and move columns and rows.
Data Table package on page 1439

Configure Wait package actions to terminate a running bot if a condition is unsatisfied
Enterprise A2019 and Community Edition
Select the Throw an exception option in the Wait for screen change and Wait for window actions
to show an error message and terminate a bot if the screen does not change or the window does
not open or close within the specified amount of time.
Using Wait for screen change action on page 1924 | Using Wait for window action on page 1927

Email trigger for new emails
Enterprise A2019 and Community Edition
Use email triggers to start a bot when a new email message is received in the specified email
service. Supported email services are:
• Microsoft Outlook
• Email Server
• Server EWS

Add an email trigger on page 2208

Generate a random integer from a user-specified range and assign it to a number
variable
Enterprise A2019 and Community Edition
Use the Random action from the Number package to generate an integer in the range of
-9,223,372,036,854,775,808 through 9,223,372,036,854,775,807.
action Numero casuale

Enterprise A2019 Bot Agent OS support
Enterprise A2019
Enterprise A2019 Bot Agent is now supported for single users on Windows Server 2019, Windows
Server 2016, Windows Server 2012, Windows 8, and Windows 7 SP1.
Compatibilità di Bot Agent on page 1025

Return the Bot Agent installation path using the system variable AAInstallationPath
Enterprise A2019 and Community Edition
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Nuove funzionalità

Copy and paste actions and triggers between bots (Service Cloud case ID: 00455116)
Enterprise A2019 and Community Edition
Use the Copy to shared clipboard and Paste from shared clipboard icons at the top of the
Bot editor to duplicate actions, triggers, and metadata at a time.

GDPR self-reporting
Enterprise A2019 and Community Edition
General Data Protection Regulation self-reporting enables the Control Room administrator to run
reports that include the following data elements (sensitive data will be masked in the output):
• User Bot Runner device access.
• User data in associated credential vault.
• Devices registered by the user.
• All documents (artifacts) uploaded or updated to public or private repositories by the user.
• All bots associated to the user.
• Bot Insight dashboard report includes a list of all dashboards associated to this user ID.

Pacchetti supportati

Pacchetto Versione

Gestione nodi 6.5.4738

Application 2.0.0-20200418-005328

Integrazione app 1.0.0-20200418-005326

Analizza 2.2.1-20200314-193039

Boolean 2.0.0-20200418-005329

Migrazione bot 2.3.0-20200424-015945

Browser 2.0.0-20200418-005330

Clipboard 2.0.0-20200418-005342

Comment 2.0.0-20200418-005342

CSV/TXT 2.0.0-20200418-005342

Database 2.0.0-20200418-005345

Data Table 2.0.0-20200418-005637

Datetime 2.0.0-20200418-005348

Delay 2.1.0-20200418-005348

Dictionary 2.0.0-20200418-005349

Run DLL 2.0.0-20200418-005620

Email 2.0.0-20200418-005352

Error handler 2.0.0-20200418-005357

Excel basic 2.0.0-20200422-000204

© 2023 Automation Anywhere. All rights reserved.     590



    Automation Anywhere - Learn

Pacchetti supportati

Pacchetto Versione

Excel advanced 2.0.0-20200422-000103

File 2.0.0-20200418-005358

File & folders 2.0.0-20200317-030352

Folder 2.0.0-20200418-005400

FTP / SFTP 2.0.0-20200418-005404

IF/ELSE 2.0.0-20200418-005406

Image Recognition 2.0.0-20200420-104210

Moduli interattivi 2.12.0-20200420-084203

IQ Bot 2.0.0-20191031-150538

JavaScript 2.0.0-20200418-005413

Simulate keystrokes 2.0.0-20200418-005415

Legacy Automation 1.0.0-20200422-075546
1.0.0-20200422-075549

List 2.0.0-20200418-005422

Log To File 2.0.0-20200418-005423

Loop 2.0.0-20200418-005424

Message Box 2.0.0-20200418-005424

Mouse 2.0.0-20200418-005428

Number 2.0.0-20200418-005433

OCR 2.1.0-20200418-005434

Office 365 Excel 2.0.0-20200418-005517

Office 365 Calendar 2.0.0-20200418-005338

Office 365 OneDrive 2.0.0-20200418-005523

PDF 2.1.0-20200418-005526

PGP 2.1.0-20200418-005528

Ping 2.0.0-20200418-005529

Stampante 2.0.0-20200418-005535

Play Sound 2.0.0-20200418-005530

Prompt 2.0.0-20200418-005536

Python Script 2.0.0-20200418-005537

Recorder 2.0.0-20200318-020414

REST Web Service 2.0.0-20200418-005619

SAP 2.1.0-20200418-005622
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Pacchetti supportati

Pacchetto Versione

Screen 2.0.0-20200418-005625

SNMP 2.0.0-20200418-005627

SOAP Web Service 3.0.0-20200418-005630

String 3.0.0-20200418-005635

System 2.0.0-20200418-005636

Attività 2.0.0-20200417,230104-1256

Terminal Emulator 2.0.0-20200418-005641

Trigger Email 1.1.0-20200418-005652

VBScript 2.0.0-20200418-005643

Wait 3.0.0-20200418-005645

Window 2.0.0-20200418-005700

Workload 2.0.0-20200422-054201

XML 2.0.0-20200418-005650

Funzionalità modificate

Build 4105 replaced with Build 4111
Build 4105 has been deprecated and replaced with Build 4111. If you have installed Build 4105
on Windows, perform a regular upgrade to get the new build. If you have installed Build 4105 on
Linux, you must uninstall it and reinstall Build 4111. After you are on Build 4111, an update to Bot
Agent 7.0.4789 is also required.
Aggiornamento alla versione di Automation 360 più recente on page 1063

User interface changes in Excel basic and Excel advanced packages
The text field titled Cell name is now Cell address in the actions from the Excel basic and Excel
advanced packages.

Specify the column title in the Get cell address action in the Excel advanced package
The Specific cell option is now the Based on header option, which accepts the column title as
either the column heading or the default column title.
Using the Get cell address action on page 1553

Edit a work item without changing its status
You no longer have to change the status of a new work item for editing. You can now edit work
items that are in New status. Previously, you were allowed to edit the work item attribute values
after changing the state of the attributes so that the edits to the work item could be saved.
Edit work items on page 2826
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Funzionalità modificate

Mark work items for reprocessing
The Ready to run action is now updated to Re-process so that you can mark work items that are
in Failed, Data error, or On hold state to New status for reprocessing.
View work items on page 2825 | Modifica code on page 2813

Problemi risolti

ID caso Service Cloud Descrizione

00560339 You can now do a second checkout of the same bot, make
updates (for example delete a command) , and check it back in.
The "File Not Found" error that prevented subsequent checkouts
of the same bot and data deletion not actually getting deleted
has been fixed.

-- Devices running an older version of the Bot Agent can now
connect to A2019.12 Control Room.

-- Secure Data Store (SDS) installation on Enterprise A2019.12 is
now working.

00530388 Multiple bot updates and check-ins succeed irrespective of the
Enterprise A2019 version used to import the bot.
Bot check-in on Cloud deployments used to fail when the bot
was imported multiple times and overwritten. This issue is now
fixed.

00521691 After Excel files are extracted from a .zip file, common tasks
such as renaming and deleting the Excel files failed. This issue is
now fixed.

00519528 Bot Scanner version 2.0.0 now works as expected. The crash
issue is now fixed.

00517040 When the Email package is used in Exchange Web Services, the
action loop exited after processing 10 emails. This early exit is
fixed. Now all specified emails are processed before the loop
exits.

00504163 When bots are run using the Open and Close actions from the
DLL package in a loop, the Bot Agent window now functions
correctly. The Bot Agent service does not require a manual
restart after a bot is run.

00494267 Actions from the DLL package can now be run inside and
outside a loop.

00494273 The Create worksheet action in the Excel advanced package
now supports default sheet names for all the supported
languages in Enterprise A2019.

00492554 The Sort table action in the Excel advanced package now
supports OS setting for the Swedish region.

00446956 The Open action in the CSV/TXT package can now read values
from files encoded with UTF-8.
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Problemi risolti

ID caso Service Cloud Descrizione

00503230 The SOAP Web Service action now supports responses with
non-English characters.

00522147 The $StringVar.String:trim$ shorthand now trims leading and
trailing spaces in a string when used in the Message box
package.

-- You can now deploy bots on selected Bot Runner devices with
the Run as option from the My bots page in an Control Room
configured on Microsoft Azure.

-- Scheduled bots now run as expected and do not get stuck in the
queue in an Control Room configured on Microsoft Azure.

-- After you capture an object in a browser or application
window, the browser window containing the Bot editor is now
reactivated. Previously, users had to manually return to the Bot
editor.
Actions in the Image Recognition, Mouse, OCR, Screen, and
Recorder packages support this feature.

00475070 Exporting a report to CSV from Activity > Historical now
correctly outputs the data.

00516331 You can now build a bot that contains more than one Database
> Read from action that is followed by a Loop action, within
the same database session. Each time the bot runs the Read
from action, the query results are refreshed, and the loop will
only iterate on the current results.

00509735 Auto Login now works when you deploy a bot as an unattended
Bot Runner on a Horizon Virtual Desktop Infrastructure (VDI)
session.

00509831 Prompt package actions now support long inputs. The user
interface displays up to 512 characters. If the input is longer
than 512 characters, the rest appear as a tooltip when the user
hovers over the prompt box.

00518566 You can now use the recorder feature within actions to
select window titles and file paths on a device that has proxy
authentication enabled. Previously, users had to manually enter
this information because they could not access the device
through actions while building a bot.

00475107 The Japanese language now supports column names when
using CSV-related actions.

00532894
00532253
00539241

When you reimport a bot using exported files from a different
Control Room of the same version (from version A2019.12
onward) and choose to overwrite the bot, you can now check-
in that bot. The error generated when you choose the overwrite
option that prevented check-in of the reimported bot is now
fixed only for version A2019.12 onward. Reimporting bots on
A2019.11 and older releases are not supported at this time.
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Problemi risolti

ID caso Service Cloud Descrizione

00521222, 00525635, 00529274,
00526613, 00526489, 00530609,
00530787, 00533445, 00535366,
00530900, 00538070

The progress of a TaskBot is not stalled at line 0 and does
not remain in queue to run when you deploy the bot on a
Bot Runner. The status of the device reflects Yet to Be
Determined until the device is available to process the items.

00421195 You can now create a work queue by providing details such as
the queue name, queue owners, participants, consumers, and
work item structure. This feature is available from Workload >
Queues > Create Queue.

00533465 When you delete any action from an existing bot, the
corresponding metadata for the deleted action is now removed
from the bot.

Limitazioni note

If you are running A2019.12 Enterprise On-Premises with build 4105 on Linux and want to use
Build 4111, then you must uninstall Build 4105 and do a fresh installation of Build 4111. You cannot
perform an upgrade to get Build 4111. Consulta Uninstall Automation 360 On-Premises from Linux
server on page 955. A2019.12 Enterprise On-Premises on Windows can be upgraded as normal.

The Send reset password email functionality (from the Administration > User page) to help
users reset their password is not working and returns a 401 error. Users should use the "Forgot
password?" flow to reset their password.

Folders created using the Folder > Create action cannot have names that contain system actions
or device references such as AUX, CON, LPT, NUL, and PRN.

Mouse click with key combo for preset triggers in SAP application is currently not supported.

The following are known limitations in the form builder:
• If the character limit is set to 0 and the field is marked necessary for the Password element in

a form, an error message is displayed when you run the bot.
• An invalid file path associated with the Document element in a form displays an error message

when the Get and Set actions of the interactive forms are used.
• A blank page is displayed on the form builder when you paste content into any of the existing

form elements.
• A form that is linked to a bot through the Display action of interactive forms is displayed in

front of all other windows, even when the Always display form window in front option is
not selected.

Cloud-enabled deployments only support local authentication.

Linux is not supported for Cloud-enabled On-Premises installations.
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Limitazioni note

• Work items might be queued on the View queues page as the number of devices in the device
pool increase. This should not affect the bot execution because the queues are cleared when the
work items are processed.

• You cannot simultaneously insert work items from multiple devices in a queue.
• You cannot create a draft queue.
• When you insert a number value using the Insert work item to a queue, the system shows an

incorrect value. For example, if you insert 023456789, the system shows 2.3456789E7.
• When you add more devices to a device pool that is processing workload management

automations, the newly added devices might not immediately pick up the pending work items.
Soluzione: Pause and resume the workload management automation.

If a device goes idle while processing workload management work items in a device pool, it will not
process the work items. However, those work items can be processed by other devices in the pool.

When you create a form with using the Document element and provide an incomplete file path,
your bot will not run successfully.

When you create a form and specify that a password is required, the password length can be set to
0.

IQ Bot (Build 4088)

Enterprise A2019.12 Build 4111 is compatible with IQ Bot A2019 (Build 4088).
The IQ Bot On-Premises version supports all the features and functionality available in IQ Bot Version
6.5.2.
IQ Bot feature comparison matrix

Review the compatibility of the IQ Bot On-Premises version with the corresponding Automation Anywhere
Control Room On-Premises version.
Compatibilità delle versioni di Automation 360 IQ Bot on page 740
The IQ Bot Cloud version is available for this release and supports all features and functionality available in
IQ Bot Version 6.5.2. This version provides users with automatic provisioning for up to three environments
such as Development, Test, and Production. Users can migrate learning instances between environments
using APIs.
The IQ Bot Community Edition and the free trial version are available for this release. Both versions have
feature parity and are based on IQ Bot Version 6.5.2.

Limitazioni note

IQ Bot On-Premises
IQ Bot registration is not supported for Cloud-enabled On-Premises installations.
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Bot Insight

Nuove funzionalità

View filtered data of the dashboard widgets
Enterprise A2019 and Community Edition
The Bot Insight dashboard widget filter enables you to apply filters across the widgets in the
dashboard to display filtered data. While the dashboard filters enable you to view different
combinations of information from a single dashboard, the widget filters enable you to drill down to
information from the already filtered data. You can also save and publish the custom dashboards
with the preset widget filters.
Bot Insight dashboard filter on page 2967

Retrieve information from the Bot Insight API, and generate and visualize data
analytics on Microsoft Power BI
Enterprise A2019 and Community Edition
The Automation Anywhere custom connector enables you to establish a secure connection to
Microsoft Power BI, and generate and visualize data analytics. You can select the Bot Insight APIs
in Microsoft Power BI and apply specific parameters for each of the APIs. The custom connector
transforms the Bot Insight API responses to data model visualizations in Microsoft Power BI.
Data connector for Power BI on page 2980

Preview and analyze business information in the default business dashboard
Enterprise A2019 and Community Edition
The Data Preview menu in the Bot Insight default business dashboard displays information that
is logged for multiple Analyze Open and Close commands used in the bot. The Preview Data
menu does not appear when you perform a comparison between the default dashboards.

API enhancements
Enterprise A2019
The deletetasklogdata API is updated to include the runId parameter. The getbotrundata
API retrieves information about the vital statistics of the bot. The getaudittraildata API
retrieves information about the audit data that is logged for all users.
Bot Insight API

Related concepts
Migrazione a Automation 360 on page 1126
Related tasks
Aggiornamento alla versione di Automation 360 più recente on page 1063
Se stai già utilizzando Automation 360 On-Premises, puoi aggiornare alla versione più recente di
Automation 360.
Aggiornamento di Automation 360 IQ Bot on page 1114
Puoi eseguire l'aggiornamento di Automation 360 IQ Bot On-Premises all’ultima versione per ottenere tutte
le funzionalità e i miglioramenti più recenti.
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Note su Enterprise Edition A2019.11
Review the new features, supported packages, changed features, fixed features, and known limitations in
the Enterprise A2019.11 (Build 3337) release. There are no security fixes in this release.
• Enterprise A2019
• IQ Bot
• Bot Insight

Enterprise A2019

Important:  This release includes a required update to your . Ensure that you complete the update to
continue with your automation activities when upgrading from a previous release to this release.
Aggiornamento automatico di Bot Agent on page 1042 | Aggiornamento manuale del Bot Agent on page 1043

To verify which  version is compatible with this release, see Compatibility with release builds on page 1026.

Nuove funzionalità

Migrate 11.x TaskBots and MetaBots to Enterprise A2019
Enterprise A2019
• Viene fornito supporto aggiuntivo per pacchetti e variabili.

Mappatura dei pacchetti per la migrazione on page 1247 | Mappatura delle variabili per la migrazione
on page 1279

• You can now migrate MetaBots (with DLLs) and their components from Enterprise 11 to
Enterprise A2019. You cannot migrate screen-based MetaBots.
Come viene eseguita la migrazione di MetaBots on page 1223

• Use the Bot Scanner to analyze MetaBots to determine if they can be migrated.
• Verify the list of certified Enterprise 11 bot versions available for migration: Versioni Control Room

supportate per la migrazione on page 1136

Bot Store integration with the Control Room
Enterprise A2019
You can now access the Bot Store from within the Control Room. You can install, configure, and run
the Bot Store bots within the Control Room.
As a registered user, you can log in to the Bot Store from the Control Room and access all your
downloads. You can install bots and packages from your downloads to the Control Room private
repository. You can also submit your existing bots and packages from the Control Room to the Bot
Store.
Bot Store on page 2944
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Nuove funzionalità

Use interactive forms in a bot
Enterprise A2019
Interactive forms provide a form builder experience for users to build interfaces for submitting and
regrouping data being used to send and receive data from various applications within their attended
automation process. Users with Bot Creator and Bot Runner license can use the interactive forms
package to control and manage the form flow within a bot during runtime. Actions performed by
users on the interactive forms can be monitored to execute logic using subtasks.
Interactive forms are first-class citizens within the bot repository and have the same workflows
for moving forms between public and private workspaces, and for export or import actions. No
additional licenses or permission are required to use interactive forms.
Action items in the interactive forms can be used to manage various forms within a bot.
Using interactive forms on page 2186

Reuse an identical value between bots by configuring a global value in the Control
Room
Enterprise A2019 and Community Edition
A global value enables users to reuse an identical value between bots instead of creating a new
variable for each bot. Global values remain constant for all users and bots in an Control Room
instance. A user with the AAE_admin role can configure a global value with a default value and
enable non-admin users to overwrite the value to use in their bots.
Valori globali on page 2044 | Crea un valore globale on page 2044 | Overwrite the default value on
page 2046

Workload enhancements
Enterprise A2019 and Community Edition
• Monitor the progress of ongoing workload automations. You can also pause, resume, or stop the

automations as required.
• Configure and edit workload automations to ensure that the automations are deployed

seamlessly to unattended Bot Runner devices. Execute the workload automations with priority or
round-robin mode from the Devices > Edit Device pool page.

• Set the output status of the work item processed in the Control Room on the Queues and
Work item details page using the $workItemResult$ variable in a TaskBot.

• Edit work items that are in Ready to run, On hold, Data error, or Failed state.
• Set the individual work item status to Mark complete, Defer, or Re-process from the Edit

work item page or in bulk from the View queues page.

View automation of a queue on page 2820 | Edit device pools on page 2638 | Edit work items on page
2826 | Use Work Item variables on page 2038

Download a file from the Control Room to your device
Enterprise A2019 and Community Edition
Use the Download CR file action from the File package to download a file from the Control Room
to your device.

Note:  You cannot use this action to download a bot or a file from the My Scripts folder.

File package on page 1562
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Nuove funzionalità

Clone a bot or files
Enterprise A2019 and Community Edition
Create a read-only copy of a selected bot or file from the public repository to the private repository.
The clone is a local copy for the same user and will not be updated with the public repository copy
automatically. This provides a testing environment experience for Bot Creators to make and validate
changes locally and take advantage of reusable TaskBots in concurrent developments by reusing an
existing bot or file as a dependency.
• Cloned bots and files cannot be edited, renamed, or moved.
• Cloned bots and files can be deleted from a private repository.
• Users can create a copy of the cloned bot.
• A cloned bot can be used in Run Task action in another bot.
• Cloned bots and files can be added as a manual dependency for another bot.

New features in the If package
Enterprise A2019 and Community Edition
• Configure an If action with multiple conditions.

Specify whether all or either of the conditions must be met.
• Verify whether JavaScript, Task, or VBScript ran successfully or not.
• Verify whether a string variable is empty or not.
• Execute actions only if two strings have matching uppercase and lowercase letters.

If package on page 1625 | Example of using a conditional statement on page 2058

Universal Recorder enhancements
Enterprise A2019 and Community Edition
Universal Recorder now enables you to:
• Automate in Java applications that run using Java Runtime Environment (JRE) 9, 10, and 11.
• Capture objects in tables in Oracle EBS applications.
• Automate interactions with user interface objects in the taskbar, desktop, or currently active

window. This option is available in the window selection drop-down list in the following
packages:
• Image Recognition
• Mouse
• Recorder
• Screen
• Simulate keystrokes
• Window

Universal Recorder for object-based automation on page 1949
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Nuove funzionalità

New features in the Excel advanced package
Enterprise A2019 and Community Edition
• In the Replace action, you can choose to replace cell values with an empty character.
• In the Get cell address action, you can choose to save the retrieved cell address to a string

variable.

Using the Replace action on page 1557 | Using the Get cell address action on page 1553

Add DLL dependencies
Enterprise A2019 and Community Edition
As a bot creator, you can use a DLL that refers to a child DLL.
Bot dependencies on page 2046

Licensing server failover
Enterprise A2019
HA failover from a primary cluster to a secondary cluster applies to all the servers, including the
licensing server, and is handled by the data center high availability tools.
Distributed architecture with HA/DR support on page 21

Automate locking, logging off, restarting, or shutting down the computer
Enterprise A2019 and Community Edition
Use actions from the System package at the end of tasks to automate locking, logging off,
restarting, or shutting down the computer.

Manage running bots with the Pause and Stop actions from the Task Bot package
Enterprise A2019 and Community Edition
• Insert a Pause action to temporarily pause the running bot.
• Insert a Stop action to terminate the running bot.

Task Bot package on page 1895

Automate printer settings
Enterprise A2019 and Community Edition
Use actions from the Printer package to automate retrieving and setting the default printer.

Return the path and name of the currently running TaskBot using the system variable
AATaskName
Enterprise A2019 and Community Edition
Variabili predefinite on page 2023
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Nuove funzionalità

Run JavaScript, Python, or VBScript from a file selected from your desktop
Enterprise A2019 and Community Edition
You can select the file containing the script as part of configuring the action.

Note:  The file and any dependencies must be in a standalone folder. When you select a file for
upload, all files and folders at the same folder level are uploaded.

JavaScript package on page 1664 | Python Script package on page 1746 | VBScript package on page
1921

Device optimization for bot deployment (Zendesk ID: 238675)
Enterprise A2019 and Community Edition
Bot Runner devices that are used for Workload automation are now available for deployment in
the Scheduled Automations page. This ensures that idle devices during a workload cycle are
available to the user with scheduling rights for Control Room deployment.
Edit device pools on page 2638

Pacchetti supportati

Pacchetto Versione

Gestione nodi 6.0.4015

Application 2.0.0-20200302-135910

Analizza 2.2.1-20200314-193039

Boolean 2.0.0-20200302-135912

Browser 2.0.0-20200302-135913

Clipboard 2.0.0-20200302-135922

Comment 2.0.0-20200302-135922

CSV/TXT 2.0.0-20200312-122802

Database 2.0.0-20200302-135926

Data Table 2.0.0-20200302-140308

Datetime 2.0.0-20200302-135930

Delay 2.1.0-20200302-135931

Dictionary 2.0.0-20200302-135932

Run DLL 2.0.0-20200313-170350

Email 2.0.0-20200302-135934

Error handler 2.0.0-20200302-135940

Excel basic 2.0.0-20200302-140133

Excel advanced 2.0.0-20200302-140020
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Pacchetto Versione

File 2.0.0-20200316-045955

File & folders 2.0.0-20200317-030352

Folder 2.0.0-20200302-135945

FTP / SFTP 2.0.0-20200302-135948

IF/ELSE 2.0.0-20200302-135950

Image Recognition 2.0.0-20200302-135953

IQ Bot 2.0.0-20191031-150538

JavaScript 2.0.0-20200313-170107

Simulate keystrokes 2.0.0-20200313-170111

Legacy Automation 1.0.0-20200317-220124
1.0.0-20200317-220128

List 2.0.0-20200302-140013

Log To File 2.0.0-20200302-140014

Loop 2.0.0-20200302-140015

Message Box 2.0.0-20200302-140016

Migrazione 2.0.0-20200317-220133

Mouse 2.0.0-20200302-140016

Number 2.0.0-20200302-140023

OCR 2.1.0-20200302-140025

Office 365 Excel 2.0.0-20200309-140138

Office 365 Calendar 2.0.0-20200305-124125

Office 365 OneDrive 2.0.0-20200309-110128

PDF 2.1.0-20200302-140126

PGP 2.1.0-20200309-110135

Ping 2.0.0-20200302-140130

Stampante 2.0.0-20200311-100204

Play Sound 2.0.0-20200309-110137

Prompt 2.0.0-20200302-140148

Python Script 2.0.0-20200313-170254

Recorder 2.0.0-20200318-020414

REST Web Service 2.0.0-20200312-090358

SAP 2.1.0-20200302-140250

Screen 2.0.0-20200302-140254

SNMP 2.0.0-20200302-140257
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Pacchetto Versione

SOAP Web Service 2.0.0-20200312-110311

String 2.0.0-20200302-140306

System 2.0.0-20200309-140321

Attività 2.0.0-20200317-030340

Terminal Emulator 2.0.0-20200302-140313

VBScript 2.0.0-20200313-170417

Wait 2.0.0-20200302-140319

Window 2.0.0-20200302-140348

XML 2.0.0-20200302-140321

Funzionalità modificate

Change in the Dictionary > Remove action
The Dictionary > Remove action offers the option to assign the removed value to a variable.
Dictionary package on page 1479

The Update migration status permission name has been changed to Allow a bot-runner user
to run migrations. All functionalities remain the same.

When multiple bots are scheduled to run on the same user or device, the bots are now queued and
run whenever the previous bots completes its run.
Service Cloud case ID: 00440072
Scheduled activities on page 2616 | Gestione del carico di lavoro on page 2797

Problemi risolti

ID caso Service Cloud Descrizione

00483976 When the copy function is used, nested subfolders were not
visible when users clicked browse to search through directories.
This issue has been fixed.

00457550 When a user checks out a bot that uses the Run action to
run child bots, the child bots are now cloned from the public
repository to the private.

00492706 When a user exports a bot from another Control Room and
imports that same bot to a new Control Room, the imported bot
and enabled packages now show all required actions.

00482934 Bot deployments and website launches are now optimized for
quicker process.

00421864 When a user is viewing historical activity details in Historical
activity, the run option is no longer displayed.
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ID caso Service Cloud Descrizione

00505120 When bots fail the check-in process, the contents are now
restored in the Private repository.

00488504 Bots with more than 100 dependencies are now exported
successfully without an error, even if the parent bots are in the
list of those 100 dependencies.

00444902 When the Control Room is used in Internet Explorer 11, the Bot
Agent is now compatible and the UI is rendered properly.

00454079 When the Capture action in the Recorder package is used,
content in the browser is captured successfully.

00460530 In a developer Control Room, a user can now successfully
import a bot with cyclic dependency.

00493605 In the Run action in the TaskBot package, the Assign the
output to variable (optional) option now functions properly
when an assigned variable is removed.

00486734 When the Set cell action in the Excel advanced or Excel basic
package is used with multiple Microsoft Excel files, the values
of the Active cell operation now activate and set the cells
accordingly in the respective Microsoft Excel file.

00530915 Migration is not advisable for Enterprise 11 customers using
Workload Management due to known issues.

-- You can now add date variables in the Vertical Bar Graph
widget in the Bot Insight Business dashboard.

00475173 All fields of the Recorder > Capture action have been
translated to Enterprise A2019 supported languages.

00476820 When a Bot Runner machine is logged off, the device shows
the state as Disconnected in the Control Room. Previously, the
device showed the state as Connected in the Control Room.

Limitazioni note

MetaBot logic that uses a DLL function call with one or more parameters migrates successfully.
However, when you run the migrated bot, an error is shown.

Global values of the Date time data type cannot be used in actions.

The Enterprise A2019 On-Premises Control Room installation does not support the semicolon
(;) special character in the Windows user password. The installation fails if you use this special
character.

When data is exported into a CSV file from User Management, Audit Logs, and Roles
Management for all locales except English, the respective language is not displayed correctly.
Workaround: Export to a CSV file and access a Microsoft Excel file. Import and save that CSV file as
a CSV with UTF-8 encoding.

Users must explicitly enable the feature flag for the forms feature in the On-Premises build.

Note:  Go to Automation Anywhere support site for more information: Interactive forms not available
in Automation 360 v.11 On-Premises (A-People login required)

© 2023 Automation Anywhere. All rights reserved.     605

https://apeople.automationanywhere.com/s/article/Interactive-forms-not-available-in-A2019-11-On-Prem-version
https://apeople.automationanywhere.com/s/article/Interactive-forms-not-available-in-A2019-11-On-Prem-version


    Automation Anywhere - Learn

Limitazioni note

Forms with many radio buttons and check boxes in the same row are not rendered correctly.

Only the Form Events and UI Triggers event types are supported by event loop as the file or
folder triggers and hot keys have issues.

IQ Bot

The IQ Bot On-Premises version is available for this release with additional features or updates since the
last release. This IQ Bot version supports all the features and functionality available in IQ Bot Version
6.5.2.
IQ Bot feature comparison matrix

Review the compatibility of the IQ Bot On-Premises version with the corresponding Automation Anywhere
Control Room On-Premises version.
Compatibilità delle versioni di Automation 360 IQ Bot on page 740
The IQ Bot Cloud version is available for this release and supports all features and functionality available in
IQ Bot Version 6.5.2. This version provides users with automatic provisioning for up to three environments
such as Development, Test, and Production. Users can migrate learning instances between environments
using APIs.
The IQ Bot Community Edition and the free trial version are available for this release. Both versions have
feature parity and are based on IQ Bot Version 6.5.2 .

Nuove funzionalità

Upgrade from earlier versions of IQ Bot to the latest IQ Bot On-Premises
IQ Bot On-Premises
If you are using any of the earlier versions of IQ Bot (5.3.x or 6.5.x), you can upgrade to IQ Bot
A2019 Build 3337 On-Premises.
Aggiornamento di Automation 360 IQ Bot on page 1114

Use API to migrate learning instances between environments
You can use an API to migrate learning instances in IQ Bot On-Premises.

Access IQ Bot from the Control Room dashboard
Enterprise A2019 and Community Edition
You can access IQ Bot from the Control Room through a link, provided you have registered IQ Bot
in the Control Room. Otherwise, the IQ Bot section remains hidden.

Limitazioni note

IQ Bot On-Premises
IQ Bot installation fails if the user password contains any of these special characters: single
quotation mark ( ' ), quotation mark ( " ), or semicolon ( ; ).
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Limitazioni note

IQ Bot Cloud
• ABBYY FineReader Engine is the default OCR for data extraction in IQ Bot Cloud.
• Data validation using Python script is not supported.
• IQ Bot extensions for custom extraction are not available.

IQ Bot On-Premises and IQ Bot Cloud
Quando si caricano documenti PDF vettoriali in una nuova istanza di apprendimento, alcuni
documenti vengono identificati come non classificati. In alternativa, se si convertono i documenti da
PDF a TIFF e li si caricano, i documenti vengono elaborati con successo.

Bot Insight

Nuove funzionalità

View filtered data of Bot Insight dashboards
Enterprise A2019
The Bot Insight dashboard filter enables you to apply filters across dashboards to display filtered
data on the dashboard widgets. The filter enables you to view different combinations of information
from a single dashboard, thereby eliminating the need to maintain separate dashboards for
different sets of users.
Bot Insight dashboard filter on page 2967

View business analytics for multiple transactions simultaneously
Enterprise A2019
The Multiple Transaction Names menu displays transactional information about bots with
multiple Analyze- Open and Close commands. Each Analyze- Open and Close command is
considered as a transaction, and each transaction is displayed as a unique block in the data preview
section. The number of rows for each unique transaction block is limited to 100.
Business dashboard on page 2962

Note su Enterprise Edition A2019.10
Review the new features, supported packages, changed features, fixed features, and known limitations in
Enterprise A2019.10 (Build 2545). There are no security fixes in this release.
• Enterprise A2019
• IQ Bot
• Bot Insight

Enterprise A2019

To verify which  version is compatible with this release, see Compatibility with release builds on page 1026.
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Nuove funzionalità

Migrate 11.3.x TaskBots to Enterprise A2019
Enterprise A2019
• Analyze whether you can migrate bots created in Enterprise Client version 10.x using the Bot

Scanner.
Analisi del report di Bot Scanner per la migrazione on page 1162

• Viene fornito supporto aggiuntivo per pacchetti e variabili.
Mappatura dei pacchetti per la migrazione on page 1247 | Mappatura delle variabili per la migrazione
on page 1279

• Multiple Bot Runner users are supported for bot migration.
Migrazione dei bots di Enterprise on page 1216

AISense Recorder to capture objects from remote applications
This is a Beta release on Enterprise A2019 (Cloud deployment only) and Community Edition
Record a task and capture objects using the AISense Recorder from applications that are usually
accessed remotely and with a complex user interface (UI).
Record a task with AISense Recorder on page 1966

Manage your automation as Work Items for resource optimization and workload
automation
Enterprise A2019 and Community Edition
Divide your automation into small, logical modules called Work Items using the new Workload
Management feature. Process these Work Items simultaneously using queues to ensure that your
organization's automation goals are achieved with optimum resource utilization.
Use the workload module to create and manage workload queues and run bots on unattended Bot
Runners through the workload queues. Also, pass the Work Item attributes or values to the bot
from the Control Room when you Run bot with queue with the help of Work Item variables.
Gestione del carico di lavoro on page 2797

Install Control Room on Red Hat Enterprise Linux 7.7 and Linux CentOS 7.7
Enterprise A2019
Use the command line to install your Control Room on your Linux servers in the datacenter.
Installing Control Room on Linux on page 948

Use wildcard characters in folder and file path fields in the Encrypt and Decrypt actions
Enterprise A2019 and Community Edition
Substitute an asterisk (*) for one or more unknown alphanumeric characters or symbols. This
maximizes the search results by returning all folders and files that contain the string that you have
specified.
Encrypt | Decrypt
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Nuove funzionalità

Use system variables to return data from the computer that is connected to the running
Bot Agent
Enterprise A2019 and Community Edition
You can use the following system variables:
• AAControlRoom: Returns the URL of the Control Room.
• CPUUsage: Returns the percentage utilization of the CPU.
• RAMUsage: Returns the RAM usage in megabytes.
• OSName: Returns the operating system.
• TotalRAM: Returns the total amount of RAM available.

Automate tasks in Oracle EBS and Forms with the Universal Recorder
Enterprise A2019 and Community Edition
Open Oracle EBS applications in a browser as Java Web Start applications or as a thick client. The
Universal Recorder can capture the following objects:
• Window/Tab
• Pulsante
• Casella di testo
• Label (read-only)
• Pulsante di opzione
• Casella di controllo
• Table/Grid
• Scroll bar
• Menu
• Combo-box/Drop-down list

Pacchetti supportati

Pacchetto Versione

Gestione nodi 2.0.2885

Application 2.0.0-20200131-085947

Analizza 2.1.0-20200204-154550

Boolean 2.0.0-20200131-085949

Browser 2.0.0-20200127-180439

Clipboard 2.0.0-20200131-085958

Comment 2.0.0-20200130-183435

CSV/TXT 2.0.0-20200205-175938

Database 2.0.0-20200205-175940

Data Table 2.0.0-20200131-200235

Datetime 2.0.0-20200131-090006
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Pacchetto Versione

Delay 2.1.0-20200131-090007

Dictionary 2.0.0-20200205-175946

Run DLL 2.0.0-20200205-230300

Email 2.0.0-20200206-135926

Error handler 2.0.0-20200130-183452

Excel basic 2.0.0-20200205-110122

Excel advanced 2.0.0-20200205-110012

File 2.0.0-20200131-090018

Folder 2.0.0-20200131-090021

FTP / SFTP 2.0.0-20200206-110020

IF/ELSE 2.0.0-20200131-090025

Image Recognition 2.0.0-20200131-090028

IQ Bot 2.0.0-20191031-150538

JavaScript 2.0.0-20200205-180013

Simulate keystrokes 2.0.0-20200205-105955

List 2.0.0-20200131-090039

Log To File 2.0.0-20200131-090040

Loop 2.0.0-20200131-090041

Message Box 2.0.0-20200131-090041

Migrazione 1.1.0-20200206-180601

Mouse 2.0.0-20200131-090044

Number 2.0.0-20200205-110015

OCR 2.1.0-20200131-090053

Office 365 Excel 2.0.0-20200205-180122

Office 365 Calendar 2.0.0-20200206-105949

Office 365 OneDrive 2.0.0-20200127

PDF 2.1.0-20200131-090152

PGP 2.1.0-20200205-110117

Ping 2.0.0-20200131-090156

Play Sound 2.0.0-20200127-180654

Prompt 2.0.0-20200127-180707

Python Script 2.0.0-20200205-180148

Recorder 2.0.0-20200212

REST Web Service 2.0.0-20200206-110309
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Pacchetto Versione

SAP 2.1.0-20200205-180245

Screen 2.0.0-20200131-090311

SNMP 2.0.0-20200207-090446

SOAP Web Service 2.0.0-20200127-180819

String 2.0.0-20200131-090323

System 2.0.0-20200205-110240

Terminal Emulator 2.0.0-20200131-090330

VBScript 2.0.0-20200205-180309

Wait 2.0.0-20200131-090335

Window 2.0.0-20200131-090337

XML 2.0.0-20200131-090339

Funzionalità modificate

Updated layout for the summary report generated by Bot Scanner
The layout of the summary report is updated to provide information about the number of bots
scanned, and the commands and variables used in the scanned bots that are supported in
Enterprise A2019.
Analisi del report di Bot Scanner per la migrazione on page 1162

Python script and VBScript packages return output without quotation marks
The actions in the Python script and VBScript packages now return output without any quotation
marks. For example, if the action previously returned "ABC" as the output, now the action returns
only ABC.

Use Microsoft SQL Server address as alias for database
Service Cloud case ID: 00401484
The Control Room now supports using a Microsoft SQL Server address as alias for a database
during installation.
Automation 360: Steps to change database server post Control Room installation (A-People login required)

Problemi risolti

ID caso Service Cloud Descrizione

00463210 In a virtual machine using Remote Desktop Protocol, the
Keystrokes action now functions properly without prompting a
special characters error.

00455359, 00466407, 00475122 When the Control Room is used in Google Chrome, renaming a
folder in the My bots section no longer causes the browser to
crash.
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ID caso Service Cloud Descrizione

00440659 In the Data Table package, the Create folders/files if it
doesn't exist option in the Write to file action now functions
properly and does not create a file when the option is not
selected.

00377861, 00466104 When you install Enterprise A2019 On-Premises with Amazon
Relation Database Service (RDS) and there is no internet
connectivity, the installation now completes successfully.

00472738, 00496476 In the Control Room, the bot now runs successfully without
prompting an interactive bot error message in any circumstance.

00472655 In the Loop action, selecting the Cell range in the Loop
through option now functions properly with the For each row
in worksheet in the Iterator option.

00475040 When a bot is developed in Google Chrome, the pause and
resume options now function correctly.

00445671 The time taken to connect to the Control Room is now less than
2 minutes after you restart the Control Room services.

00421864 You can now configure your Bot Agent using the Google Chrome
browser. The following error message is no longer displayed:
Please use Chrome to configure your bot agent.

00462095 Bot compilation time has decreased, so it takes less time for the
bot to run. Previously, some bots took up to 40 seconds in pre-
processing mode.

IQ Bot

The IQ Bot On-Premises version is available for this release with additional features or updates since the
last release. This IQ Bot version supports all the features and functionality available in IQ Bot Version
6.5.2.
IQ Bot feature comparison matrix

Review the compatibility of the IQ Bot A2019 On-Premises version with the corresponding Automation
Anywhere Control Room On-Premises version.
Compatibilità delle versioni di Automation 360 IQ Bot on page 740

Nuove funzionalità

IQ Bot On-Premises unified database
IQ Bot Build 2545 On-Premises now supports a unified database. You have to run a migration script
to migrate the databases of Builds 1089, 1598, and 2079 to Build 2545.
Esegui script di migrazione del database IQ Bot On-Premises on page 1114

Note:  The version number in the IQ Bot installer is incorrect and will be fixed in the next release.
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Bot Insight A2019

Nuove funzionalità

New Bot Insight homepage
The new homepage displays all the available dashboards in a single page and enables you to
directly access the dashboard of your choice. The smart search functionality enables you to search
for dashboards in the Search text field. The homepage also enables you to bookmark your favorite
dashboards and to sort the dashboards based on the following parameters:
• Dashboard Name
• Type
• Total Views
• Last Refreshed

Dashboard di Bot Insight on page 2956

Operations dashboard
View information about the bots that are deployed on different Bot Runner machines and their
statistics based on the performance from the Bot Insight Operations dashboard. You can use this
information to enhance productivity and take measures based on real-time information for RPA
deployments.
You can directly access the Bots and Audit dashboards from the hyperlinks in the Operations
dashboard.
Operations dashboard on page 2959

Transaction data
View data that is aggregated and logged by the bots when they are deployed in the Bot Runner
machines by using the Transaction data feature in the Profile menu. You can access this feature
from the Business dashboard.
Business dashboard on page 2962

Exporting data from widgets
Export data that is generated by the various smart widgets to comma-separated value (CSV) files
on your local drive from the Custom Business dashboard. The export file for all the widgets,
except the Data Table Chart and the US Map, contains the following headers:
• Gruppo
• Subgroup
• Metrica
• Volume

The Data Table Chart export file contains all the headers that are present in the Data Table
Chart. The US Map export file contains the state codes, metric values, and the volume headers.
Exporting data from a dashboard widget on page 2980
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Nuove funzionalità

Visualization updates
Customize the widgets on the Bot Insight dashboards to gain insights for specific scenarios. The
following widgets are added to Bot Insight:
• Heat Map
• Data Table Chart

Bot Insight visualizations on page 2976

Limitazioni note

Using the Universal Recorder in Oracle EBS applications:
• The Select item by text action does not retrieve the value of a selected ListView object.

Workaround: Manually enter the item value after capturing the object control or use the Select item
by index action.

Note:  Item index count starts at 1.

• At runtime, the Select item by text and Select item by index actions do not appear to select the
item specified in a PageTab object, but the bot successfully executes the action.

• At runtime, the Select item by text and Select item by index actions do not appear to select the
item specified in a ComboBox object, but the bot successfully executes the action.

In Enterprise A2019 On-Premises, the following activities are currently not logged in the workload logs:
• Create a queue
• Create a device pool
• Create a bot
• Run a bot with a queue

You can access the logs from the C:\ProgramData\AutomationAnywhere\Logs folder.
Related information
https://www.automationanywhere.com/in/lp/rpa-editions-comparison

Note di rilascio di Enterprise A2019 (Build 2094)
Queste note sulla versione descrivono funzionalità nuove e modificate, problemi risolti, correzioni per la
sicurezza, funzionalità obsolete e limitazioni note introdotte in Enterprise A2019 (Build 2094).
To verify which  version is compatible with this release, see Compatibility with release builds on page 1026.

Enterprise A2019 Build 2094

La build 2094 contiene aggiornamenti per quanto segue:
• Enterprise Community Edition
• Bot Insight A2019
• IQ Bot A2019
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• On-Premises (Build 2079)

Nuove funzionalità della build 2094

Funzionalità Descrizione

Migrazione Migrazione di TaskBots Enterprise 11.3.x a
Enterprise A2019.
• Eseguire lo Bot Scanner (precedentemente

denominato utilità di pre-migrazione) per
analizzare se è possibile migrare i bot
Enterprise 11.x (attualmente supportate
solo 11.3.1, 11.3.2 e 11.3.2.x) a Enterprise
A2019. L'utilità genera un report di riepilogo
in formato HTML e un report separato per
ciascun bot in formato XML.
Panoramica di Bot Scanner on page 1158

• Eseguire la migrazione di più TaskBots con
TaskBots dipendenti usando un singolo utente
Run-as.
Migrazione dei bots di Enterprise on page 1216

• Come parte del processo di migrazione di bot,
è possibile identificare la migrazione TaskBots
effettuata in precedenza nella pagina di
selezione dei bot e visualizzare un elenco di
TaskBots dipendenti prima di finalizzare la
migrazione.
Migrazione dei bots di Enterprise on page 1216

• Analizzare lo stato delle singole migrazioni bot
e identificare eventuali comandi o attributi
non supportati associati al bot migrato e alle
relative dipendenze.
Visualizza i rapporti di migrazione on page
1299

• Viene fornito supporto aggiuntivo per
pacchetti e variabili.
Mappatura dei pacchetti per la migrazione on
page 1247

SAML 2.0 Passare un database Control Room di ambiente
autenticato a un provider di identità SAML (IDP).
Configurazione dell'autenticazione SAML on page
995
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Funzionalità Descrizione

Bot Distribuisci API The Bot Deploy API now includes /
automations/deploy and is introduced
to support the runAs user feature for Bot
deployment.
• L'API di distribuzione Bot funziona solo

negli account pubblici Enterprise e non in
Community Edition.

• L'API supporta l'URL di callback per gli
ambienti che hanno sia il server Control Room
di callback che sulla stessa rete.

Geo Presence La funzionalità Geo Presence è un miglioramento
Cloud Control Room multi-tenant, sicuro,
scalabile, per comunicare in modo sicuro con gli
utenti e Bot Runners su una rete del cliente.

Supporto dei servizi Web Exchange Actions in Email package consente agli utenti di
automatizzare le operazioni correlate alle e-mail
utilizzando Exchange Web Services (EWS).
Email package on page 1493

Variabili al posto di un indice o di un valore
chiave

Le variabili di tabella dati, dizionario, lista e tipo
di record possono esprimere i valori di indice e
chiave come variabili.
Variable types on page 2028

Copia bot La funzionalità di copia bot conserva i metadati
del bot originale, incluse le immagini acquisite,
gli oggetti registrati, i file chiamati e il bots figlio.
Copy a bot on page 2005

actions Excel per recuperare la posizione di
cella, colonna o riga

I seguenti actions consentono agli utenti di
recuperare le informazioni sulla posizione da un
foglio Excel e salvarle in una variabile.
• Ottieni indirizzo di cella
• Ottieni colonna
• Ottieni riga

Miglioramenti del registratore Gli utenti possono eliminare l'oggetto acquisito
più di recente mentre il registratore è in
esecuzione.

Pacchetti supportati

Pacchetto Versione

Gestione nodi 1.0.1891

Applicazione 2.0.0-20191223-210256
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Pacchetto Versione

Operatore booleano 2.0.0-20191223-210258

Browser 2.0.0-20191223-210259

Appunti 2.0.0-20191223-210308

Commento 2.0.0-20191223-210309

CSV/TXT: 2.0.0-20191223-210310

Database 2.0.0-20191223-210312

Tabella dati 2.0.0-20191223-210802

Data e ora 2.0.0-20191223-210316

Ritardo 2.1.0-20191223-210318

Dizionario 2.0.0-20191223-210318

DLL 2.0.0-20191223-210742

E-mail 2.0.0-20200114-060001

Gestione errori 2.0.0-20191223-210326

Excel 2.0.0-20200107-140225

Excel_MS 2.0.0-20200107-140116

File 2.0.0-20200114-060009

Cartella 2.0.0-20200114-060012

FTP/SFTP 2.0.0-20191223-210334

If/Else 2.0.0-20191223-210336

DI 2.0.0-20191223-210339

IQ Bot 2.0.0-20191031-150538

JavaScript 2.0.0-20191223-210345

Pressione di tasti 2.0.0-20191223-210348

Elenco 2.0.0-20191223-210350

LogToFile 2.0.0-20191223-210350

Loop 2.0.0-20191223-210352

MessageBox 2.0.0-20191223-210352

Migrazione 1.1.0-20200111-070201

Mouse 2.0.0-20191223-210355

Numero 2.0.0-20191223-210402

OCR 2.1.0-20191223-210525

Excel per Office 365 2.0.0-20191231-170605

Office 365 Calendar 2.0.0-20191231-170422

OneDrive per Office 365 2.0.0-20191231-170612
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Pacchetto Versione

PDF 2.1.0-20191223-210631

PGP 2.1.0-20191223-190649

Ping 2.0.0-20191223-210634

PlaySound 2.0.0-20191223-210636

Richiedi 2.0.0-20191231-130717

Python 2.0.0-20191223-210644

Registratore 2.0.1-20200111-070529

Inattive 2.0.0-20191231-120639

SAP 2.1.0-20191223-210745

Schermo 2.0.0-20191223-210748

SNMP 2.0.0-20191223-210752

SOAP 2.0.0-20191210-081952

Stringa 2.0.0-20200114-110316

Sistema 2.0.0-20191223-210800

Emulatore di terminale 2.0.0-20191223-210806

VBScript 2.0.0-20191223-210809

Attendi 2.0.0-20191223-210812

Finestra 2.0.0-20191223-210814

XML 2.0.0-20191223-210815

Funzionalità modificate

Funzionalità Descrizione

Autorizzazione pacchetti Office 365 Autorizzare ogni package Office 365
separatamente tramite il package Connetti in
ogni package.
Using Connect action for Office 365 packages on
page 1705

Problemi risolti

Funzionalità Descrizione

Bot Agent In Control Room, l'aggiornamento alla versione
di Bot Agent più recente ora esegue bot senza
alcun messaggio di errore richiesto. Consulta
Switch Bot Agent to a different Control Room on
page 1045.
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Funzionalità Descrizione

Pacchetto avanzato Excel Nel package Excel avanzato, l'azione Chiudi
ora termina solo una sessione aperta specifica
definita dal nome sessione.

Pressione di tasti Il comando Sequenze di tasti funziona
correttamente con il layout della tastiera
giapponese.

Correzioni per la sicurezza

Le correzioni di sicurezza in questa versione non sono cambiate rispetto alla versione precedente. Per un
elenco di queste correzioni, consulta Enterprise A2019 (Builds 1598 and 1610) Release Notes on page 621.

Funzionalità obsolete

Le funzionalità obsolete in questa versione non sono cambiate rispetto alla versione precedente. Per un
elenco di queste funzionalità obsolete, consulta Enterprise A2019 (Builds 1598 and 1610) Release Notes on
page 621.

Limitazioni note nella build 2094

Migrazione
• Quando si seleziona un bot per la migrazione, i valori delle colonne Ultima migrazione e Autore

migrazione potrebbero differire per lo stesso bot nelle tabelle File disponibili e Selezionati.
• Il valore "Sistema" nella colonna Autore migrazione indica che il bot non è stato migrato in

precedenza.
• Quando visualizzi i comandi e le variabili associati a ogni botmigrato, dovresti visualizzare solo i comandi

e le variabili non supportati. Attualmente, vengono visualizzati tutti i comandi e le variabili.

IQ Bot Build 2079

La versione IQ Bot On-Premises è disponibile per questa versione con funzionalità o aggiornamenti
aggiuntivi dall'ultima versione. Questa versione si basa su caratteristiche e funzionalità IQ Bot Version
6.5.2.
IQ Bot feature comparison matrix

La versione IQ Bot On-Premises è compatibile con la versione Automation Anywhere Control Room On-
Premises corrispondente.
Compatibilità delle versioni di Automation 360 IQ Bot on page 740
Per una nuova installazione Control Room, l'utente deve caricare il pacchetto IQ Bot manualmente. Per i
dettagli, vedi Add packages to the Control Room on page 2649.
Visita il sito di supporto Automation Anywhere per scaricare e installare il pacchetto:
A-People Downloads page (Login required).
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Problemi risolti IQ Bot

Le funzioni corrette di questa versione non sono cambiate rispetto alla versione precedente.

Correzioni per la sicurezza di IQ Bot

Le correzioni di sicurezza in questa versione non sono cambiate rispetto alla versione precedente.

Funzionalità obsolete di IQ Bot

Le funzionalità obsolete in questa versione non sono cambiate rispetto alla versione precedente.

Limitazioni note di IQ Bot

In questa versione non sono presenti nuove limitazioni note.

nuove funzioni Bot Insight in Build 2094

Funzionalità Descrizione

Visualizzazioni Il widget Visualizzazione nel dashboard Bot
Insight fornisce una serie di widget altamente
personalizzabili da utilizzare per ottenere
informazioni dettagliate in scenari specifici.
Vengono aggiunte barre in cluster e impilate
in verticale e in orizzontale.
Adding a dashboard widget on page 2976

Funzionalità modificate di Bot Insight

Le funzioni modificate di questa versione non sono cambiate rispetto alla versione precedente.

Problemi risolti Bot Insight

Le funzioni corrette di questa versione non sono cambiate rispetto alla versione precedente.

Funzionalità obsolete di Bot Insight

Le funzionalità obsolete in questa versione non sono cambiate rispetto alla versione precedente.

Limitazioni note di Bot Insight

Le limitazioni note in questa versione non sono cambiate rispetto alla versione precedente.
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Enterprise A2019 (Builds 1598 and 1610) Release Notes
These release notes describe new features, changed features, fixed features, security fixes, deprecated
features, and known limitations in Enterprise A2019 (Builds 1598 and 1610).
To verify which  version is compatible with this release, see Compatibility with release builds on page 1026.

Enterprise A2019 Builds 1598 and 1610

La build 1598 contiene aggiornamenti per quanto segue:
• Enterprise Community Edition
• Bot Insight
• IQ Bot

La build 1610 contiene aggiornamenti per quanto segue:
• On-Premises
• Bot Insight
• IQ Bot

New features in Builds 1598 and 1610

Funzionalità Descrizione

Pre-migration utility for On-
Premises

The Automation Anywhere pre-migration utility evaluates
your 11.x bots for migration to Enterprise A2019.
Run the pre-migration utility to verify whether your
existing 11.x bots can be migrated to Enterprise A2019.
Use the summary report generated by the utility to
identify the bots that can and cannot be migrated and
decide if you want to start the migration.

Note:  This is an initial version of the pre-migration
utility. We plan to include updates to the utility in
upcoming releases to help migrate most of your bots.

On-Premises Windows installer Enterprise A2019 On-Premises Windows installer is
certified for Azure.

Bot Creator and Bot Runner on
Azure Cloud

Users can create and execute bots for devices on Azure
Cloud.

Action localization Labels, buttons, and tooltips are localized to the
supported language set.

Updated action packages • Additional REST Web Service error codes for better
troubleshooting of API calls

• PGP package for encrypting and decrypting files
• Improvements to SAP actions
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Funzionalità Descrizione

Control Room to a SAML-based,
SSO-authenticated Control Room

Enterprise A2019 integrates with SAML identity providers
(IDPs). Post installation, administrators can switch the
Control Room to a SAML-based, SSO-authenticated
Control Room.

Move email messages to different
folder

The Move message command enables the user to move
all the filter-matched emails to a different folder.

Pacchetti supportati

Pacchetto Versione

Gestione nodi 1.0.2110

Applicazione 2.0.0-20191128-060339

Operatore booleano 2.0.0-20191128-060340

Browser 2.0.0-20191128-060342

Appunti 2.0.0-20191128-060350

Commento 2.0.0-20191128-060351

CSV/TXT: 2.0.0-20191128-060352

Database 2.0.0-20191128-060354

Tabella dati 2.0.0-20191128-060707

Data e ora 2.0.0-20191128-060358

Ritardo 2.1.0-20191128-060359

Dizionario 2.0.0-20191128-060400

DLL 2.0.0-20191128-060648

E-mail 2.0.0-20191205-100336

Gestione errori 2.0.0-20191128-060404

Excel 2.0.0-20191128-060547

Excel_MS 2.0.0-20191128-060434

File 2.0.0-20191128-060407

Cartella 2.0.0-20191128-060409

FTP/SFTP 2.0.0-20191128-060412

If/Else 2.0.0-20191128-060414

DI 2.0.0-20191121-100240

IQ Bot 2.0.0-20191031-150538

JavaScript 2.0.0-20191128-060423

Pressione di tasti 2.0.0-20191128-060426

Elenco 2.0.0-20191128-060427
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Pacchetto Versione

LogToFile 2.0.0-20191128-060428

Loop 2.0.0-20191128-060429

MessageBox 2.0.0-20191128-060429

Mouse 2.0.0-20191128-060430

Numero 2.0.0-20191128-060437

OCR 2.1.0-20191121-100301

PDF 2.1.0-20191128-060540

PGP 2.1.0-20191129-100500

Ping 2.0.0-20191128-060544

PlaySound 2.0.0-20191128-060545

Richiedi 2.0.0-20191128-150505

Python 2.0.0-20191128-060553

Registratore 1.0.45-20190904-210340

Inattive 2.0.0-20191128-060646

SAP 2.1.0-20191128,003143-259

Schermo 2.0.0-20191121-100518

SNMP 2.0.0-20191128-060656

Stringa 2.0.0-20191128-060704

Sistema 2.0.0-20191128-150557

Emulatore di terminale 2.0.0-20191128-060711

VBScript 2.0.0-20191121-110553

Attendi 2.0.0-20191128-060716

Finestra 2.0.0-20191128-060718

XML 2.0.0-20191017-030831

Problemi risolti

Le funzioni corrette di questa versione non sono cambiate rispetto alla versione precedente. For a list of
these features, see Enterprise A2019 (Builds 1082 and 1089) Release Notes on page 626.

Correzioni per la sicurezza

Le correzioni di sicurezza in questa versione non sono cambiate rispetto alla versione precedente. Per un
elenco di queste correzioni, consulta Enterprise A2019 (Builds 1082 and 1089) Release Notes on page 626.
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Funzionalità obsolete

Le funzionalità obsolete in questa versione non sono cambiate rispetto alla versione precedente. Per un
elenco di queste funzionalità obsolete, consulta Enterprise A2019 (Builds 1082 and 1089) Release Notes on
page 626.

Known limitations in Builds 1598 and 1610

• IQ Bot is not supported in Automation Anywhere Cloud and users cannot register any IQ Bot instance
with the Cloud Control Room.

• If a bot is deployed on a device, no other bots can be deployed on that device until the first bot has
completed the deployed task.

• When deploying a bot using Unattended Bot Runner on a virtual machine with Windows 10 desktop,
users have to enable remote access to the device (Control Panel > System Properties > Allow
Remote Access).

• Deploying a bot with Bot Runner on a locked device will leave that device in an unlocked state.
• A Bot Creator is not able to view devices as assigned by the Control Room administrator. With this

release, changes to the basic role has removed the View and manage all devices permission so that
unless this permission is expressly granted by the Control Room administrator, the Bot Creator will no
longer be able to see other devices in the Control Room. Bot Creators can register their devices directly;
however, they will not be able to see the other devices in the Control Room.

• Unable to deploy bots from a private workspace using the wizard. Bot Creators can deploy bots from
the editor.

• If users have set up Active Directory for Control Room authentication, changing to SAML or Control
Room Database is not supported.

• Device pool administrators can delete a device pool after automation is scheduled and assigned to the
pool.

• Users without SMTP can still import bots and packages.
• When users delete a bot from the Public workspace, the same bot is deleted from the Private

workspace as well.
• Elastic Search Disaster Recovery backup is not supported.
• Using the Run Task action with the child task using triggers is not supported.
• User cannot export a bot with dependencies if that user does not have access to any of the related

dependencies.
• Users cannot check out bots if they are linked through circular dependencies.
• Minimizing the window for some Microsoft Active Accessibility apps, such as Notepad, Calculator, or

Remote Desktop Applications, can cause the operation to fail.
• UI Automation, such as Snagit Editor Window for example, will not work in the background unless

expressly minimized.
• UI Triggers are not generating events with Snagit Editor or Inflow app.
• Applications such as calculator use different technologies on Windows 10 vs. Windows 2012 or other

servers. In these cases, when a bot is created in one server configuration, the bot cannot be carried to
another server. User triggers in these cases will not trigger bot deployment and there are no errors in
the trigger listener or node manager logs.

• UI Triggers that are configured with multiple triggers are taking as much as 25 seconds to complete.
• UI Triggers with a single capture and a filter do not work with files larger than 2 MB.
• Button events where a user is switched from one window to a new window of an application fail to

deploy a bot when listening for UI Triggers.
• For Automation Anywhere Elastic Search Service users, the C:\ProgramData

\AutomationAnywhere folder has to be removed before installing Enterprise A2019.
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• Users cannot enable SMTP with TLS for the On-Premises version of the Control Room (On-Premises
only).

• User credentials are not editable (On-Premises only).
• Even when a newly added device is registered correctly, the indication icon does not turn green.
• Activity - In Progress table is not cleaning event records until the user performs a hard refresh (F5)

of the browser.
• Domains are not shown for the Device/Run as tab when creating a role. This option is also missing

when running a bot.
• Node manager is not able to establish a handshake SSL connection to the Control Room running on SSL

certificate (On-Premises only).
• Repository Management API is incomplete; there is only one URL in the Swagger file.
• Device pools display completed automations, not scheduled automations.
• If a user is not the device pool administrator, the devices are not correctly displayed when editing a

device pool.
• For an Unattended Bot Runner, with a device assigned and auto-login credentials set, and Run as self

selected, the Run now option is disabled.
• When a user is running a bot from the Run Wizard and the Bot Agent requires an update, after the user

has updated the agent from the pop-up box, the user cannot deploy the bot until the user navigates
back to the previous page and returns to the workflow to run the wizard.

• Folder triggers do not deploy bots when a folder change event occurs.

IQ Bot Builds 1598 and 1610

La versione IQ Bot On-Premises è disponibile per questa versione con funzionalità o aggiornamenti
aggiuntivi dall'ultima versione.

Funzionalità modificate di IQ Bot

IQ Bot is compatible with A2019 Builds 1598 and 1610.

Problemi risolti IQ Bot

Le funzioni corrette di questa versione non sono cambiate rispetto alla versione precedente.

Correzioni per la sicurezza di IQ Bot

Le correzioni di sicurezza in questa versione non sono cambiate rispetto alla versione precedente.

Funzionalità obsolete di IQ Bot

Le funzionalità obsolete in questa versione non sono cambiate rispetto alla versione precedente.

Limitazioni note di IQ Bot

In questa versione non sono presenti nuove limitazioni note.
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Bot Insight new features in Builds 1598 and 1610

Funzionalità Descrizione

Operation dashboard The Operation dashboard in Bot Insight
displays the Audit dashboard.
You can search for the dashboards using the
Search text box. Puoi anche personalizzare le
dashboard in base alle tue esigenze. Il controllo
degli accessi basato sui ruoli e le autorizzazioni
vengono applicati alle dashboard in modo
che queste mostrino solo i dati che un utente
specifico è autorizzato a visualizzare.
Consulta Operations dashboard on page 2959.

Analytic visualization widgets The following new widgets are added:
• Stacked Bar Chart
• Clustered Bar Chart

Consulta Adding a dashboard widget on page
2976.

Funzionalità modificate di Bot Insight

Le funzioni modificate di questa versione non sono cambiate rispetto alla versione precedente.

Problemi risolti Bot Insight

Le funzioni corrette di questa versione non sono cambiate rispetto alla versione precedente.

Funzionalità obsolete di Bot Insight

Le funzionalità obsolete in questa versione non sono cambiate rispetto alla versione precedente.

Limitazioni note di Bot Insight

Le funzionalità obsolete in questa versione non sono cambiate rispetto alla versione precedente.

Enterprise A2019 (Builds 1082 and 1089) Release Notes
These release notes describe new features, changed features, fixed features, security fixes, deprecated
features, and known limitations in Enterprise A2019.
To verify which  version is compatible with this release, see Compatibility with release builds on page 1026.
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Enterprise A2019 Builds 1082 and 1089

La build 1082 contiene aggiornamenti per quanto segue:
• Enterprise Community Edition
• Bot Insight

La build 1089 contiene aggiornamenti per quanto segue:
• On-Premises
• IQ Bot
• Bot Insight

New features in Builds 1082 and 1089

Funzionalità Descrizione

Universal recorder support for SAP The universal recorder now supports the SAP graphical
interface for fast and accurate control and ease of editing
generated scripts.

Citrix support Citrix agent enables remote application recording for
object cloning on Citrix servers and leverages ICA to
create user sessions.

Enhanced code editing Select multiple lines of code in editor to copy, move,
disable, enable, as well as disable/enable a line of an
action in a bot script.
Users can run bots from a particular line of code or action
inside the bot.

Bot import and export Users can export bots with dependencies into a common
zip file, including all actions. Users can manually exclude
packages from the export process.
All imported action packages will be automatically
installed into the target Cloud Control Room and the bots
placed inside the user private workspace.

Elaborazione in background Background processing for Citrix Virtual Apps and
Windows native applications. Excel packages inherently
support background processes.

REST package Support for GET, POST (text, XML, and HTML), PUT, and
DELETE methods. Authentication types supported include
Basic, Logged-in AD user, and NTLM.

OCR Action Users can capture window and capture image by path.

Active Directory integration for On-
Premises

Allowing auto-discovery of sites and domains, Enterprise
A2019 On-Premises integrates Active Directory to support
multi-domain as well as multi-forest deployments.
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Pacchetti supportati

Pacchetto Versione

Gestione nodi 1.0.1745

Applicazione 2.0.0-20191016,213334-22

Operatore booleano 2.0.0-20191017-030403

Browser 2.0.0-20191017-030404

Appunti 2.0.0-20191016,213334-16

Commento 2.0.0-20191017-030408

CSV/TXT: 2.0.0-20191017-030409

Database 2.0.0-20191017-030411

Tabella dati 2.0.0-20191029,062940-3

Data e ora 2.0.0-20191017-030416

Ritardo 2.1.0-20191017-030417

Dizionario 2.0.0-20191017-140648

DLL 2.0.0-20191031-100332

E-mail 2.0.0-20191024-120209

Gestione errori 2.0.0-20191031-100110

Excel 2.0.0-20191024-160417

Excel_MS 2.0.0-20191101-120011

File 2.0.0-20191017-140654

Cartella 2.0.0-20191017-140657

FTP/SFTP 2.0.0-20191023-181858

If/Else 2.0.0-20191017-030432

DI 1.0.0-20190923-115359

IQ Bot 2.0.0-20191031-150538

JavaScript 2.0.0-20191031-100128

Pressione di tasti 2.0.0-20191018-100419

Elenco 2.0.0-20191017-030447

LogToFile 2.0.0-20191017-030447

Loop 2.0.0-20191017-030449

MessageBox 2.0.0-20191017-030449

Mouse 2.0.0-20191017-030450

Numero 2.0.0-20191029-100152

OCR 2.1.0-20191017-030626

PDF 2.1.0-20191017-030713
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Pacchetto Versione

Ping 2.0.0-20191017-030715

PlaySound 2.0.0-20191024-160415

Richiedi 2.0.0-20191024-160423

Python 2.0.0-20191031-100238

Registratore 1.0.45-20190904-210340

Inattive 2.0.0-20191024-090501

SAP 2.1.0-20191031-100334

Schermo 2.0.0-20191017-030809

SNMP 2.0.0-20191023-181621

Stringa 2.0.0-20191025-221016

Emulatore di terminale 2.0.0-20191023-181907

VBScript 2.0.0-20191031-100352

Attendi 2.0.0-20191017-030828

Finestra 2.0.0-20191017-030829

XML 2.0.0-20191017-030831

Funzionalità modificate

Funzionalità modificate

TaskBot All rich features of MetaBot, such as DLL and
code protection using execute permission,
are now part of a standard TaskBot. This also
includes inline scripting using Python, VBScripts,
and more to help reduce the learning curve
for new users and provides a uniform bot
development experience.

Problemi risolti

Le funzioni corrette di questa versione non sono cambiate rispetto alla versione precedente. For a list of
these features, see Note di rilascio di Enterprise A2019 (Build 550) on page 633.

Correzioni per la sicurezza

Le correzioni di sicurezza in questa versione non sono cambiate rispetto alla versione precedente. Per un
elenco di queste correzioni, consulta Note di rilascio di Enterprise A2019 (Build 550) on page 633.
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Funzionalità obsolete

Le funzionalità obsolete in questa versione non sono cambiate rispetto alla versione precedente. Per un
elenco di queste funzionalità obsolete, consulta Note di rilascio di Enterprise A2019 (Build 550) on page 633.

Known limitations in Builds 1082 and 1089

• IQ Bot is not supported in Automation Anywhere Cloud and users cannot register any IQ Bot instance
with Cloud Control Room.

• To create database tables in Cloud Control Room where internet access is restricted and deploying
Liquibase, users are required to unblock the Java process to connect to www.liquibase.org in order to
download the schema and allow java.exe to have internet access.

• The Folder trigger has the following event options: create, modify, and delete. The File trigger only
has the modify and delete event options.

• A bot cannot have duplicate Triggers that point to the same directory.
• Using the action Run Task with the child task using triggers is not supported.
• Activity - In Progress is not cleaning the event record until user does hard refresh (F5) of the browser.
• User cannot export a bot with dependencies if that user does not have access to any of the related

dependencies.
• Users cannot checkout bots if they are linked via circular dependencies.
• Minimizing the window for some Microsoft Active Accessibility apps, such as Notepad, Calculator, or

Remote Desktop Applications, can cause the operation to fail.
• UI Automation, such as Snagit Editor Window for example, will not work in the background unless

expressly minimized.
• If the system Citrix plugin is not updated, the Recorder will not launch.
• If the user renames a previously saved recorder bot, a download error is generated and results in loss

of images.
• For Elasticsearch users, remove the C:\ProgramData\AutomationAnywhere folder prior to

installing Enterprise A2019.
• Users cannot enable SMTP with TLS for the on-premises version of the Control Room (On-Premises

only).
• User credentials are not editable (On-Premises only).
• Installer fails to create credentials using Windows Authentication. Use SQL Authentication service

credentials (On-Premises only).
• In an On-Premises environment, creating credentials with the Credential Vault is not supported in this

release.
• When using the Recorder with Citrix in an On-Premises deployment, the Citrix Agent could generate an

internal server error during the recording process.

IQ Bot Builds 1082 and 1089

IQ Bot Community Edition is available for this release. IQ Bot is not yet available on Automation Anywhere
Cloud.
Consulta IQ Bot Community Edition quick start guide .

Funzionalità modificate di IQ Bot

IQ Bot is compatible with Enterprise A2019 Build 1089.
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Problemi risolti IQ Bot

Le funzioni corrette di questa versione non sono cambiate rispetto alla versione precedente.

Correzioni per la sicurezza di IQ Bot

Le correzioni di sicurezza in questa versione non sono cambiate rispetto alla versione precedente.

Funzionalità obsolete di IQ Bot

Le funzionalità obsolete in questa versione non sono cambiate rispetto alla versione precedente.

Limitazioni note di IQ Bot

For On-Premises, if IQ Bot and Control Room are installed on the same machine, on restarting the
machine, IQ Bot does not work, and displays an error message.

Note:  We recommend restarting Automation Anywhere Control Room Reverse Proxy service to resolve
the issue.

Bot Insight new features in Builds 1082 and 1089

Funzionalità Descrizione

Smart data profiling for country, state, and
zip codes

Bot Insight analyzes information provided in the
variables to automatically identify information
based on the country, state, and zip or postal
code. You can use this information to create the
World and US Map widgets.
Consulta Editing a data profile on page 2966.

Business data delete API Use this API to delete logged data from either
the production mode or the development mode
for a particular Control Room instance.
DELETE <control_room_url>/
v2/botinsight/data/api/
deletetasklogdata.

Business data profile API Use this API to extract the business
data profile logged in Bot Insight.GET
 <control_room_URL>/v2/botinsight/
data/api/gettaskvariableprofile

Business data API Use this API to extract the business data logged
in Bot Insight.
GET https://{{ControlRoomURL}}/v2/
botinsight/data/api/gettasklogdata?
botname=<botname>
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Funzionalità Descrizione

Resize dashboard widgets You can resize and save the widgets in the Bot
Insight dashboard based on your requirements.
When you resize a dashboard widget, other
widgets in the dashboard are automatically
adjusted to fill in the available layout.
Consulta Editing a dashboard widget on page
2978.

US map widget The US Map widget enables you to visualize and
analyze information about Country, State, City,
and Zip Code.
Consulta Adding a dashboard widget on page
2976.

World map widget The World Map widget enables you to visualize
and analyze information about Country, State,
Zip Code, Latitude, and Longitude.
Consulta Adding a dashboard widget on page
2976.

Parent child dashboard When you create a new bot, Bot Insight
automatically creates a default dashboard. If you
have a parent bot and a child bot, Bot Insight
creates a separate dashboard for each of the
bots.
Consulta Dashboard di Bot Insight on page 2956.

Notification of variable updates in the
standard dashboard

Data profile updates are highlighted with a red
dot in the standard dashboard.
Consulta Customizing a dashboard on page 2970.

Data logging When you deploy and run a bot on the Bot
Runner machine, Bot Insight aggregates all
the information about that bot. Il dashboard
pubblicato per tale bot mostra le informazioni
aggregate del bot.
Consulta Dashboard di Bot Insight on page 2956.

Bot Insight The Analyze package provides the following
functions to enable business analytics in the Bot
Insight dashboard:
• Analyze Open
• Analyze Close

Funzionalità modificate di Bot Insight

Le funzioni modificate di questa versione non sono cambiate rispetto alla versione precedente.
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Problemi risolti Bot Insight

Le funzioni corrette di questa versione non sono cambiate rispetto alla versione precedente.

Funzionalità obsolete di Bot Insight

Le funzionalità obsolete in questa versione non sono cambiate rispetto alla versione precedente.

Limitazioni note di Bot Insight

Le limitazioni note in questa versione non sono cambiate rispetto alla versione precedente.

Note di rilascio di Enterprise A2019 (Build 550)
Queste note sulla versione descrivono funzionalità nuove e modificate, problemi risolti, correzioni per la
sicurezza, funzionalità obsolete e limitazioni note introdotte in Enterprise A2019 (Build 550).

New features in A2019 Build 550

Funzionalità Descrizione

On-premises installer The on-premises installation application for Enterprise
A2019.

IQ Bot supports IE11 IQ Bot (Build 550) supports Internet Explorer version 11
(IE11).

Download all documents action Use the Download all documents action to download
the extracted results from an IQ Bot server that was
created by running a TaskBot, using the Upload
Document action.

Supported packages in Build 550

The supported packages in this release have not changed since the previous release. For a list of these
packages, see Note di rilascio di Enterprise A2019 (Build 543) on page 635.
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Funzionalità modificate

IQ Bot (Build 550) Changed Features

Problema Descrizione

Language toggle UI redesigned On the IQ Bot landing page, user can click the
language toggle at the top right corner, to select
a language from the drop-down list. The UI
displays in the selected language.
User can select a language from either the
Control Room or IQ Bot language toggle icon.

Note:  After logging out of the system, the
system performs a reset. This requires the user
to select the language again at login.

Upload document action The Upload document action lets you to
upload documents for processing with IQ Bot,
using a TaskBot.

Problemi risolti

IQ Bot (Build 550) fixed features:
• Japanese documents using Microsoft Azure Computer Vision OCR engine get classified correctly.
• In the Designer window, during document training, user is able to move from one page to the other

successfully along with mapping of form and table fields.
• Download API can download successfully processed documents after moving the bot and learning

instance to production.

Correzioni per la sicurezza

No security features are introduced in this build.

Funzionalità obsolete

No deprecated features are introduced in this build.

Limitazioni note

IQ Bot (Build 550) known limitations:
• When using Internet Explorer (IE) 11, icons disappear after a page refresh. A hard refresh (Ctrl plus F5)

helps fix the issue.
• When using Internet Explorer (IE) 11, if user imports a domain, the system shows an error message.

However, the feature works as expected.
• User is unable to migrate IQBA files from other versions of IQ Bot.
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• IQ Bot portal does not launch after a machine restart. User has to restart Automation Anywhere Control
Room Reverse Proxy Service as well.

Note di rilascio di Enterprise A2019 (Build 543)
Queste note sulla versione descrivono funzionalità nuove e modificate, problemi risolti, correzioni per la
sicurezza, funzionalità obsolete e limitazioni note introdotte in Enterprise A2019 (Build 543).
To verify which  version is compatible with this release, see Compatibility with release builds on page 1026.

New features in A2019 Build 543

Funzionalità Descrizione

Next generation bot workbench Create bots from any device, from anywhere through
a web browser. The intuitive new design for applying
multiple personas with varying bot building skills
and a redesigned work area for simple assembly and
deployment. These include:
• A universal recorder to simplify capturing processes
• List and Flow views for TaskBot creation
• Powerful bot code management capabilities
• Rich variable passing with no cross-language mapping

required

Bot Runner Access and run bots from the cloud. When bots are
deployed to Bot Runners, any dependent actions are also
deployed. When updates to Actions are available, the
updates are also automatically pushed.

Package manager The package manager centralizes control over bundled
actions to enable users to deploy and upgrade only those
targeted actions being used.

Advanced variable types Access expanded variables and array types for enhanced
action implementation, including DateTime, numbers, list,
Boolean, dictionary, multi-dimension arrays for reading
Microsoft Excel documents, and file data column for .CSV
files.

Inline scripting Native support for Python and VBScript inline scripting
languages enables simple data passing between scripts
and bots.

New UX The new user experience provides assistance for users
who are getting started and includes step-by-step
guidance for common tasks.

Excel automation Configure Microsoft Excel TaskBot automation without
installing Microsoft Office on the Bot Runner machine.

Recording of automation Record automation, even from a remote device.

IQ Bot Enterprise A2019 will fully support IQ Bot, the only AI-
driven solution for users to automate processing of
complex documents.
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Funzionalità Descrizione

Bot Insight The Analyze package provides the following functions to
enable business analytics in the Bot Insight dashboard:
• Analyze Open
• Analyze Close

Table 1: Supported packages in Build 543

Pacchetto Versione

Gestione nodi 1.0.1221

Applicazione 1.0.0-20190919,040305-1231

Operatore booleano 1.0.0-20190919,040305-1435

Browser 1.0.0-20190919,040305-1287

Appunti 1.1.0-20190919,040305-1492

Commento 1.0.0-20190919,040305-633

CSV/TXT: 1.2.0-20190919,040305-1349

Database 1.1.0-20190919,040305-1287

Data e ora 1.0.0-20190919,040305-1189

Ritardo 1.1.0-20190919,040305-1492

Dizionario 1.0.0-20190919,040305-1337

DLL 1.0.0-20190920,070246-677

E-mail 1.0.0-20190919.040305

Gestione errori 1.0.0-20190919,040305-1333

Excel 1.1.0-20190921,042722-1353

Excel_MS 1.0.0-20190921,042722-1309

File 1.0.0-20190919,040305-1382

Cartella 1.0.0-20190919,040305-1337

FTP/SFTP 1.0.0-20190919,040305-660

If/Else 1.0.0-20190919,040305-1375

DI 1.0.0-20190923,062209-1140

IQ Bot 2.0.0-20191031-150538

JavaScript 1.0.1-20190919,040305-989

Keystroke 1.1.0-20190919,040305-1492

Elenco 1.0.0-20190919,040305-1466

Accedi al file 1.1.0-20190919,040305-1456

Loop 1.0.0-20190919,040305-1466
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Pacchetto Versione

Finestra di messaggio 1.1.0-20190919,040305-1492

Mouse 1.1.0-20190919,040305-1492

Numero 1.0.0-20190919,040305-1148

PDF 1.1.0-20190919,040305-1492

Ping 1.0.0-20190919,040305-1319

PlaySound 1.0.0-20190919,054049-118

Richiedi 1.1.0-20190919,040305-1180

Python 1.0.3-20190919,040305-1287

Registratore 1.0.45-20190904,153347-191

RunTask 1.1.0-20190701,181500-763

SAP 1.1.0-20190923,152217-493

Schermo 1.0.0-20190919,040305-1105

SNMP 1.0.0-20190919,040305-359

Passaggio 1.0.0-20190701,181442-695

Stringa 1.1.0-20190919,040305-1469

Tabella 1.0.0-20190919,040305-719

VBScript 1.0.1-20190919,040305-1334

Attendi 1.0.0-20190919,040305-1287

Finestra 1.0.0-20190919,040305-1333

XML 1.0.0-20190919,040305-717

Funzionalità modificate

This build does not include any changed features.

Problemi risolti

No fixed features are introduced in this build.

Correzioni per la sicurezza

No security fixes are introduced in this build.

Funzionalità obsolete

No deprecated features are introduced in this build.
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Limitazioni note

Funzionalità Limitation description

Registratore .NET Framework 4.6.1 is required for the
Recorder package.

Bot agent Users of build 543 are required to download and
install the latest agent.

Bot Insight Bot Insight has the following limitations:
• Bot Insight dashboard does not support Drag

and Drop to move and arrange the dashboard
widgets within the dashboard.

• The Date widget in the dashboard displays
the Unix time stamp.

• Bot Insight does not support the Aggregate
By feature in the Table widget, if the table
contains a Timestamp.

• Once the bots run successfully, the default
dashboard is generated after 5 to 10 seconds.

Note sulla versione Community Edition
Rivedi le nuove capacità nelle diverse versioni di Automation 360 Community Edition.

Important:  Enterprise A2019 è ora denominato Automation 360. Sebbene le note sulle versioni
precedenti alla Automation 360 v.21 facciano riferimento al vecchio nome del prodotto, il contenuto di
queste note sulla versione è applicabile e rilevante per Automation 360.

Note:  Per informazioni sulla patch v.24R2 Automation 360 per Community Edition, vedi Note sulla versione
di v.24R2 Automation 360 per EOL Internet Explorer 11 on page 259.

Segui i link per visualizzare gli aggiornamenti delle note sulla versione per la rispettiva versione.
Related concepts
Note sulla versione Automation 360 on page 63
Esamina le nuove capacità, le modifiche, le correzioni (problemi risolti), le correzioni di sicurezza, le
funzionalità obsolete e le limitazioni di ogni versione.

Note sulla versione Automation 360 v.28 Community Edition
Data di rilascio: 22 marzo 2023

Scopri le nuove funzioni nella Community Edition della versione Automation 360 v.28 (Build 17464).

Important:  Questa versione include un aggiornamento di Bot Agent facoltativo. You can continue to
run your existing bots without updating the Bot Agent. However, if you want to use the new features in
Automation 360 v.28, you must update the Bot Agent available with this release.
Per informazioni sull'aggiornamento a questa versione, consulta le seguenti risorse:
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• Aggiornamento automatico di Bot Agent on page 1042 | Aggiornamento manuale del Bot Agent on page 1043
• Compatibility with release builds on page 1026

RPA Workspace

Novità

Workday package
You can use the new Workday package from Automation 360 to automate your Workday processes
such as reporting, data upload/download, or triggering workflows with our new point-and-click
experience. The package provides deep API-level integration with Workday that enables you to
build automations easily, without having to code.

Apigee package
You can use the new Disconnect and Resume Integration features in the Apigee package. You can
disconnect from your Apigee instance and clear the session using the Apigee Disconnect action. You
can resume an integration that is suspended in Apigee using the Apigee Resume Integration action.

Extended attributes supported in the Terminal Emulator Package (Service Cloud case ID:
01870633, 01928396, 01809815)
The TN3270E terminal type supports extended attributes. To enable extended attributes for
TN3270E terminals, select the Extended Attribute check box in the Connect action.

Enhanced error messages display errors from the child bots (Service Cloud case ID:
01264352)
When you create a bot where the parent bot calls a child bot, and if an error occurs in the child bot,
the error message provides the following details:
• Line number of the parent bot which ran the child bot.
• Line number of the child bot where the error occurred.
• Error message details, such as what went wrong with that line number and the corresponding

corrective action.

Timeout option in Database Connect action (Service Cloud case ID: 00753858)
We added a timeout option in the Connect action of the Database Package. When you connect
with Microsoft SQL Server to automate database-related tasks, and if the database is down or
experiences any network issues, the automation will time out and fail if the database connection is
not established in the specified time.
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Novità

Improved readability with new formatting capabilities in XML document (Service Cloud
case ID: 01886455, 01925386)
When you insert, update, or delete nodes, the XML package does not remove carriage return
characters between nodes but does remove all blank text nodes from the XML document. By using
Prettyprint to format XML files, developers can easily improve the readability of a document.
Developers can save time by using the following new options that have been added to the XML
Package:
• Use Prettyprint: The Save session data action supports the Prettyprint format in the XML

document. When you select the Use Prettyprint check box and use the Insert node, Update
node, or Delete node actions and then save the XML document, the code is formatted with
proper indentation as per Prettyprint.

• Remove text nodes that contain only white space: The Start Session action provides an
option to remove blank text nodes when you parse the XML document.

New features added to the Email Package (Service Cloud case ID: 01835214, 01846425,
01756713, 01882482)
To support extensive process automation, we added the following action-related features to the
Email Package:
• Ability to use the Reply All action.
• Enhanced the Delete all action to delete all emails from a specific folder. Additionally, you can

apply filter parameters to emails such as:
• All, Read, and Unread
• Subject
• From a specific sender
• Before, on, or after a received date

• The dictionary variable for email properties includes a new variable, emailNoOfAttachments, used
to retrieve the attachment count.

Automate controls using Microsoft UI Automation (COM) technology
You can use the Microsoft UI Automation (COM) technology to automate the following scenarios:
• Capture and automate link controls
• Capture and automate tree controls

Insert Custom column in Data Table
A new Custom column option has been added to the Data Table > Insert column action that
enables you to insert a new column at a specified index in a data table. When you read an Excel
spreadsheet and assign it to a data table, you can modify the table by adding a new column and
entering any required data.

New Label option in Loop package
A new Label option has been added to the Loop package that enables you to break or continue a
specific loop from the nested loops.

Add and configure If action conditions
You can add and configure a maximum of 32 conditions in a single If action.
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Novità

Improved automation reliability for web applications
When you use the Recorder > Capture action to automate web pages running on Google Chrome
and Microsoft Edge browsers, the Recorder > Capture action no longer scrolls down the web
page if the target object is visible on the screen. By having a fixed top pane on the web page, the
user experience and automation reliability are improved particularly if some physical actions (such
as mouse clicks) do not work as expected.

Note:  Ensure that you install the browser extension (version 3.0.8.0) and use the Recorder
package (version 2.10.2) to capture the control.

Preferred view retained as default view in the Bot editor
As a bot developer, you no longer have to manually select the preferred view when you open the
Bot editor. To improve the developer's productivity and user experience, when creating bots in
the Bot editor, your preferred view (List, Flow, or Dual) in the Bot editor will persist across user
sessions and browsers. When you navigate in the Control Room or after your next log in, the Bot
editor will retain your last used or selected view.

Line markers for collapsible sections of code in the Bot editor
When you create bots using Loop, If/If-else, Step, Trigger-loop, Try, Catch, and Finally
statements, the Bot editor clearly shows the collapsible sections. When building automations,
developers can use these visual indicator line markers at the beginning and end of the collapsible
section to improve their productivity.

Note:  The visual indicator line marker for the collapsible section applies only to the List view in
the Bot editor.

Cosa è cambiato

Improved secure registration for Community Edition or Automation 360 users
When a user registers for the Community Edition or Automation 360 account, the registration email
sent to the user contains a temporary registration link used to create the user credentials. This
registration method is more secure than sending the user their password in plain text.

Automation Anywhere Robotic Interface (AARI)

Novità

Stationary action buttons
While completing forms in AARI, action buttons are positioned in the fixed footer of the form. The
footer and its contents are responsive to the size of your window and adjust to fit buttons and
minimize the footprint.

Forms have improved responsiveness due to this next generation of form rendering technology.
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Document Automation

Cosa è cambiato

Important:  New Community Edition users will have access to Document Automation
but not IQ Bot
As of Automation 360 v.27 release and later, only Document Automation will be provisioned to new
Community Edition users. New users will not have IQ Bot permissions, however, IQ Bot will be
available for existing, registered users.

Note sulla versione Automation 360 v.27 Community Edition
Data di rilascio:15 dicembre 2022

Scopri le nuove funzioni nella Community Edition della versione Automation 360 v.27 (Build 16701). Build
16701 replaces Build 16667.

Nota:  Questa versione include un aggiornamento di Bot Agent facoltativo. You can continue to run your
existing bots without updating the Bot Agent. However, if you want to use the new features in Automation
360 v.27, you must update the Bot Agent available with this release.
Per informazioni sull'aggiornamento a questa versione, consulta le seguenti risorse:
• Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina

1043
• Compatibility with release builds alla pagina 1026

Updated release build

The updated Build 16701 includes fixes for the following issues (Service Cloud case ID: 01937106,
01947340, 01829572):
• Bots were failing because of file dependency or interactive form that included multibyte characters in

file names.
• Changes to AARI desktop Assistant to manage and clear automations for start, stop, and resume

actions.

RPA Workspace

Novità

Windows 365 Cloud PC now supported as Bot Runner (Service Cloud case ID: 01792699)
We support Windows 365 Cloud PC as a Bot Runner to create and run bots on Windows 365 Cloud
PC.
Automation 360 Bot Runner device requirements alla pagina 829
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Novità

View keyboard shortcuts in Bot editor
In Bot editor, you can now open a menu to view the available keyboard shortcuts.
Keyboard shortcuts alla pagina 2019

Enhanced Automation Anywhere Debugger tool
The Automation Anywhere Debugger tool is available in the Bot Assistant utility to provide a
better user experience. When you invoke the Debugger tool from the Bot editor, you can add,
update, or delete actions and variables in a bot.
By default, the Watched variables lists is empty. With a single click, you can add all the used
variables in a bot. These variables display in a pop-up window where you can select or deselect,
one or more variables, from the list.
Debugger tool

ServiceNow package
You can use the ServiceNow package from Automation 360 to authenticate and perform several
actions with records and attachments in ServiceNow tables.
ServiceNow package alla pagina 1845

ServiceNow triggers
You can use ServiceNow triggers to call an action when there is a new or updated record.
ServiceNow New Record trigger alla pagina 2216

Quick assistance at hand for the developers in the Bot editor
The accessibility and usability of the Bot editor, actions, and packages have been improved. As
a citizen developer or an RPA developer, when you are creating bots, you can quickly look up
information about the actions without navigating outside the Bot editor. Under the Actions pane,
quick help is enabled with contextual information about actions. Additionally, an icon is configured
with a link to the documentation. If you want more information about an action, you can click the
link, which redirects you to the relevant page in the documentation portal. This feature is currently
available in the following actions and packages.
• Database
• Email

Enhanced user experience through refreshed and intuitive icons
With the new and intuitive icons for actions in the Bot editor, citizen developers and RPA developers
can quickly locate the correct action while creating automation for a day-to-day task. These unique
and renewed icons are developed according to brand and global standards.

New option in Read from action of Database package (Service Cloud case ID: 01263940)
A new check box is available when you use the Read from action to retrieve records from the
database and save the retrieved data in a CSV file. When you select this check box, no CSV file is
created if the executed SQL query does not return any data.
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Novità

64-bit ODBC driver now supported in Database package (Service Cloud case ID: 01256142,
01829360, 01849908)
We now support connecting to databases by using the 64-bit ODBC driver. This option is available
when the connection mode is the default. Organizations transitioning to Office 365 will benefit from
leveraging this enhancement and can sustain automation build with 32-bit ODBC drivers.
Utilizzo dell'action Connetti per il database alla pagina 1451

OAuth 2.0 support in Email and Email trigger packages (Service Cloud case ID: 01798311,
01803702, 01791859, 01828526)
Microsoft is deprecating the ability to use Basic authentication in Exchange Online for these specific
protocols:
• IMAP
• POP3
• EWS

We support OAuth 2.0 authentication for these protocols in the Email and Email trigger packages.
For enhanced security, you can maintain the business continuity of your email automations by
switching the authentication type from Basic to OAuth 2.0, (as recommended by Microsoft).
Using Connect action for Email alla pagina 1497

Retry mechanism supported in credential variables (Service Cloud case ID: 01786319,
01887182)
The credential variables support the retry mechanism. When you create a bot that uses credential
variables, if the bot fails during run time to retrieve those variables from the Credential Vault
because the Control Room is disconnected or the Control Room services stop intermittently, then
the bot tries three times to retrieve the credential variables from the Credential Vault.

Nota:  Ensure that the Bot Agent version installed on your system is the version that is released
with Automation 360 v.27.
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Support of other domain name in the Active Directory package (Service Cloud case ID:
01807358, 01910765)
We now support Active Directory user operations by logon name with domain and can provide the
domain name to extract user details. When you retrieve the user property or perform any user
operation based on the logon name (userPrincipalName), and if the user domain name differs from
the domain specified in the LDAP path, the user properties are now successfully retrieved with or
without a domain name.
For example, LDAP Path: LDAP://ADServer/DC=automation, DC=net

Utente Gruppo di accesso

userPrincipalName: kim@aaengg.net User can provide logon name as
kim@aaengg.net.

userPrincipalName: shaun@aasales.net User can provide logon name as
shaun@aasales.net.

userPrincipalName:sarah@automation.net user can provide a logon name as either sarah
or sarah@automation.net.

The following list of actions supports logon name with domain.
• Aggiorna dettagli utente
• Rinomina utente
• Elimina utente
• Attiva account utente
• Disattiva account utente
• Imposta proprietà utente
• Ottieni proprietà utente

User account operations alla pagina 1386

Nuova action nel package Text file
You can use the new Read variables action in the Text file package to read the values of variables
from the text file.

Nota:  The Import string from text file action in the String package has been deprecated and
will not be available for new bots. We recommend that you use the new Read variables action
with enhanced capabilities. This deprecation does not impact any existing bots or bots which were
migrated previously and they will continue to run properly. See Support and deprecation policy for
packages alla pagina 744 for package lifecycle and deprecation policy.

Read variables action alla pagina 1916

Call an existing JavaScript function in a webpage
You can use the new Call a JavaScript function action in the Browser package to call an existing
JavaScript function directly in a webpage or in an iFrame within a webpage in Google Chrome
and Chromium-based Microsoft Edge browsers. In the bot, you can also pass one or more input
parameters to the JavaScript function and process the return value from the function.
Call a JavaScript function action alla pagina 1426
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Novità

Automate controls using Microsoft UI Automation (COM) technology
You can use the Microsoft UI Automation (COM) technology to automate the following scenarios:
• Capture and automate client controls
• Capture and automate password text controls
• Capture and automate page tab controls

Actions performed on objects captured with Universal Recorder alla pagina 1755 | Capture using specific
technology alla pagina 1770

Capture objects on applications running in administrator mode
You can use the Recorder to capture objects on applications running in administrator mode. To
capture the object, select the Capture and run with admin privileges option from the Bot
editor.
Pacchetto Recorder alla pagina 1751

Enhanced bot performance when using global values across bots
When you use global values across a parent bot and a child bot, the bot performance is enhanced
by reducing the bot execution time. To enable enhanced bot performance, you must set the Bot
compatibility version to 3 in the Advanced settings page of the Bot editor.

Nota:  Ensure that the Bot Agent version installed on your system is the version that is released
with Automation 360 v.27.

Versione di compatibilità di Bot alla pagina 2016

Enhanced user interface for Define functionality in AISense Recorder
• We have enhanced the user interface of Define window in the AISense Recorder that enables

you to use anchors easily and automate UI objects that are not detected by AISense Recorder
automatically. To improve functional clarity, the following object types are renamed:
• Active text is renamed to Link
• Passive text is renamed to Text value

• If you unintentionally click the screen or click before the highlighter appears, the AISense
Recorder provides visibility into it. You must confirm to capture the object again or use the
Define functionality to define the object on the screen.

• In the Define window, the AISense Recorder shows embedded help for each of the control
types so you can select the correct control types for custom objects.

Use variable anchor alla pagina 1984 | Capture Textbox, Radio, Checkbox, and Combobox alla pagina
1978 | Capture text value through AISense Recorder alla pagina 1976 | Capture link button through
AISense Recorder alla pagina 1975 | Capture Image button through AISense Recorder alla pagina 1973

New virtual key added to the Simulate keystrokes package
In the Simulate Keystrokes > Keystrokes action, a new key named Return has been added
to the virtual keyboard for Enter functionality and the Enter key in the Number pad has been
renamed to Num Enter. As a result, the Return key is the main Enter key on the keyboard. This
enhancement keeps the keyboard in sync with the physical keyboard. The nomenclature has been
changed to avoid confusion between the Enter key on the keyboard and the Enter key on the
Number pad.
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Support for global variable for all Datetime actions
In the Datetime package, you can use the Datetime global variable across all Datetime actions.
You can select to use either String variable or a Global variable in the Source date and time
variable option. This avoids creating multiple local variables and reduces the total number of
actions used in a bot.
Datetime package alla pagina 1471

Workato Integration
You can integrate the Automation 360 platform and Workato by using the Automation Anywhere
connector. You can establish a connection with the Automation Anywhere Control Room and
perform various operations using the Control Room APIs.
Workato integration

SnapLogic Integration
You can now integrate the Automation 360 platform and SnapLogic. You can establish a connection
with the Automation Anywhere Control Room and perform various operations by using the Control
Room APIs.
Snaplogic integration

Automation Anywhere Robotic Interface (AARI)

Novità

Build forms easily by dragging elements to form builder
You can now build your forms by just dragging your elements to a blank form builder. As you add
elements to the form builder, it automatically adjusts without your input, letting you focus on the
form-building experience. You can also re-size the columns of your elements.
Create a form alla pagina 2186

New actions in the Process Composer
In the Process Composer, you can now use a set of actions when you build out your process. For
example, you can double-click a task, such as Bot Task and Human Task, and the task will be
updated in your process flow automatically. With this, you can save time because you do not need
to task specific tasks to your process. In addition, you can now copy, cut, and paste using CTRL +
C, CTRL + X and CTRL + V, respectively to retain, reuse, or replace data.
Behaviors supported in the Process Composer alla pagina 2144 | Crea un processo AARI alla pagina
2133

Use a reference ID meta type in Process Composer
You can now use a reference ID with a Meta variable type for your variables in the Process
Composer. When you set a reference ID as a meta variable type, you can now use your reference
ID data when you run your tasks in the web interface. This simplifies your references because you
only need to rely on using the reference ID instead of relying on other variable types or references.
Crea un processo AARI alla pagina 2133
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Novità

Center your forms in preview
You can now preview your forms in the new preview window and get an accurate assessment on
how your form will look when it is rendered. You can select the Make form preview centered
option to enable the preview window. You can also set the appropriate display resolution, x and y
coordinates, and even center your form.
Create a form alla pagina 2186

Upload images directly to the form composer
You can now upload images directly to the form composer by using the Image element. This saves
you time to view the images in the form without a file reference, rather than in the initial step,
where the image requires a file reference to be viewed.

Nota:  Image files are limited to 150 kb (like a logo).

Using the Image element alla pagina 2195

Change label action for Button element
The change label action in the form rules now applies to the Button element. When you use the
change label action in form rules and apply it to the buttons in your form, the changes will be
automatically applied to the buttons where you set the rules. This keeps the flow consistent with
the elements that you are using because all the buttons inherit the same rule.
Aggiunta di regole agli elementi di un modulo alla pagina 2202

Rules editor for Table element
The rules editor is now applicable to the Table element. When you use the rules editor for your
tables, the rules conditions are applied for each individual columns while any actions that you set
are applied for each row in the row level. This makes things consistent for each new or existing row
that you use because all the rows inherit the same rule.
Aggiunta di regole agli elementi di un modulo alla pagina 2202

Document Automation

Novità

Document Automation supports regular expression pattern-based extraction
When configuring fields that the learning instance will extract, you can specify a regular expression
(regex) pattern to help the extraction engine find the field. After entering the regex pattern you can
test the expression using sample content within the Create Learning instance window. You can
use regex pattern extraction for values that follow a specific pattern, such as a VAT number or a PO
number.

Validation interface support for shortcut keys
Zoom in and out on documents in the Validation interface by holding the Alt key and scrolling with
your mouse wheel.
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Automation 360 v.26 Community Edition Release Notes
Release date: 22 September 2022

Review what's new in the Community Edition of the Automation 360 v.26 (Build 15450) release. Build
15450 replaces Build 15439.

Note:  The v.26 build supports Manifest V3 browser extensions for Google Chrome and Microsoft Edge
browsers. For more information, see Chrome and Edge Manifest V3 extensions on page 807.

Bot agent update:  This release includes an optional Bot Agent update. You can continue to run your
existing bots without updating the Bot Agent. However, if you want to use the new features in Automation
360 v.26, you must update the Bot Agent available with this release.
For more information on updating to this release, see these resources:
• Aggiornamento automatico di Bot Agent on page 1042 | Aggiornamento manuale del Bot Agent on page 1043
• Compatibility with release builds on page 1026

RPA Workspace

What's new

Community Edition users provisioned to closest region
Registered Community Edition users are now provisioned to a region that is closest to their country
(either in the US or EU). Provisioning is based on the country of the users account.

Support for Manifest V3 extensions
Automations that use Google Chrome Manifest V2 based extensions will stop working sometime
after June 2023. The deprecation timelines of Manifest V2 based extensions are currently under
review and subject to change by Google.
• For Google Chrome Manifest V2 extensions timelines, see Manifest V2 support timeline.
• For Microsoft Edge Manifest V2 extensions timelines, see Overview and timelines for migrating to

Manifest V3.

This might impact your existing automations that use Manifest V2 based extensions for Google
Chrome and Microsoft Edge browsers. Automation 360 v.26 and later includes Manifest V3
extensions by default to support features that use Google Chrome and Microsoft Edge browsers.
You can automatically enable Manifest V3 based extensions for Google Chrome and Microsoft Edge
on all the Bot Runner devices by enabling the Browser extensions option from the Control Room.
Enabling this option applies the browser extension settings on all the registered Bot Agent devices.

Note:  We will continue to support Manifest V2 based extensions for Google Chrome until June
2023. To know about Microsoft Edge Manifest V2 based extensions timelines, see Overview and
timelines for migrating to Manifest V3.

Note:  Manifest V3 extension is supported on Google Chrome and Microsoft Edge browsers version
91 and later only.

Configure browser extensions on page 2728 | Chrome and Edge Manifest V3 extensions on page 807
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What's new

Microsoft Windows 11 Enterprise now supported (Service Cloud case ID: 01252605,
1252605, 1253745, 01255134, 01379865, 01801610, 01810148)
We now support Microsoft Windows 11 Enterprise, so you can now install and update the Bot Agent
and run bots on the Windows 11 Enterprise operating system.
Compatibilità di Bot Agent on page 1025

Salesforce command package
You can now authenticate from Automation 360 to access Salesforce and run several command
actions by using the new Salesforce command package.
Salesforce package on page 1791

SAP GUI 770 version now supported (Service Cloud case ID: 01793132, 01792775, 1776805,
01792623, 787725, 01805482, 01805479,01792623, 01810356, 01822839, 01851451, 01853577,
01860050)
SAP GUI 770 (patch 6) is now certified and supported with Recorder and SAP package.
Recorder actions supported in various SAP versions on page 1772

Configure and use custom proxy configuration in REST Web Service package (Service
Cloud case ID: 01271527, 01765084, 01839282)
REST Web Service package is now enhanced to support custom proxy configuration for each
Delete, Get, Patch, Post, and Put action. This provides you more flexibility in calling REST APIs
with different proxy configuration and allow you to create hybrid API automation.
REST Web Service package on page 1777

Keyboard shortcuts to reduce scrolling
When developing large bots, you can now use keyboard shortcuts to expand and collapse individual
or all sections and move through the lines of code quickly instead of scrolling and minimizing
sections individually.
Keyboard shortcuts to expand or collapse elements in bot logic on page 1362

Set value in any editable control field to be blank in SAP application (Service Cloud case
ID: 00821861, 01807129)
When you use the Set text action of the SAP package, you can now set the value in any editable
control field in the SAP application to be blank. For example, you can set the value in the text field
or the date field to be blank.

Loop through emails and move them one at a time (Service Cloud case ID: 00749763,
01807189, 01840743)
You can now loop through all the emails in a mailbox and move one email at a time to a destination
folder by using the Move action in the Email package.
Move action on page 1507

Configure p12 certificate for SOAP-based automations (Service Cloud case ID: 00757213)
In the SOAP Web Service action, you can now select the p12 certificate file and provide a password
for user authentication. With this enhancement, you can now access web services that use the p12
certificate-based authentication (a more secure type of SSL certificate).
Esempio di utilizzo dell'azione Servizio Web SOAP on page 2076
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What's new

Improved accessibility, usability of content on Terminal Emulator window (Service Cloud
case ID: 01609467)
You can now have improved accessibility and usability of the content displayed on the Terminal
Emulator window. When you use the enhanced Get text action of the Terminal Emulator package,
you can now view and extract all the lines and text present in the Terminal Emulator window and
perform an operation based on your requirement.
Using Get text action for Terminal Emulator on page 1908

Run bots with or without window title matching in letter case
You can now run bots even when the title of a captured window does not match the letter case. For
a bot to identify a static window or browser titles and titles with a wildcard character, you can opt
for a case-sensitive match if you want the letter case to be matched, or a case-insensitive match
otherwise, by using the Case sensitive option.

Control image preview and storage in Control Room during secure recording
You can now choose whether or not the object images are available for preview and stored in the
Control Room during secure recording by enabling the Recorder preview image setting. When
you enable the setting, the image is previewed in the Bot editor and stored in the Control Room for
60 minutes. If you choose not to preview, images are not captured.
Registrazione sicura on page 37 | Secure recording mode on page 1964 | Impostazioni on page 2721

Automate Microsoft Excel spreadsheets from SharePoint
You can now automate Microsoft Excel spreadsheets that are uploaded and shared on SharePoint.
Use Excel advanced > Open action to open the Microsoft Excel spreadsheets from SharePoint
location.
Using the Open action for Excel advanced on page 1539

Automate Citrix Virtual Apps in Edge with IE mode
When using the Recorder, you can now automate Citrix Virtual Apps running on Microsoft Edge
Chromium with IE mode.

Automate controls using Microsoft UI Automation (COM) technology
For automation, you can now use the Microsoft UI Automation (COM) technology in the following
scenarios:
• Capturing controls with secure recording mode
• Capturing and automating combo box and list view controls
• Using Object exists and Object does not exist Recorder conditions in If, Loop, and Wait

packages

Capture using specific technology on page 1770 | Actions performed on objects captured with Universal
Recorder on page 1755
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What's new

Seamless automation of Citrix Virtual Apps and other Citrix applications
With the new Automation 360 remote agent for Citrix, you can now seamlessly automate all types
of Citrix Virtual Apps and other Citrix applications that are supported on desktop applications using
the Recorder.
The new Automation 360 remote agent for Citrix supports the following browsers and technologies:
• Google Chrome
• Internet Explorer
• Microsoft Edge
• Microsoft Edge con modalità IE
• Mozilla Firefox
• Java
• Electron apps
• Microsoft Active Accessibility (MSAA)
• Microsoft UI automation

Installing Automation Anywhere remote agent on Citrix servers on page 882 | Using the Recorder on
Citrix Virtual Apps servers on page 878

Implement coding standards with code analysis
You can now implement best coding practices by configuring coding rules in the Control Room.
This feature helps you prevent potential errors, improve bot reliability, and makes the code more
uniform, accessible, reliable, and efficient.
• As an administrator or a user with View policies and Manage policies permission, you can

configure the code analysis policy for all users.
• As a Citizen Developer, you can run code analysis to analyze your bots against readability,

maintenance, security, and compliance best practices.

Analisi del codice on page 2782

Fetch execution details for specific execution IDs with new Control Room API
You can now fetch the execution details, such as botOutVariables and CallbackInfo, for a
specific execution ID by using the new API endpoint, V3/activity/execution/<id> API.
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Automation Anywhere Robotic Interface (AARI)

What's new

Embedded automation with OAuth 2.0
Embedded automation streamlines access to the automation experience.
Embedded Automation on page 2218
• AARI Integrations embeds in web applications as a widget, so if you are an end user, you can

access automated processes and bots without leaving your environment.
• AARI Extensions offers further adaptability through Chrome browser extensions, enabling

automation directly in any web scenario. Business users can now access automations through a
widget, available through an extension in their web browser.

• With an OAuth 2.0 connection, existing access to automations in the Control Room are now
shared with the Extensions to offer you a seamless user experience.

AARI Integrations e AARI Extensions on page 2221

Delete files permanently from AARI cloud storage
You can now delete files permanently from AARI cloud storage. When you delete a request, the
associated file is also permanently deleted now and not just sent to the recycle bin.
Cloud storage usage on page 2130

Append or overwrite operations in your form
Append or overwrite operations in your form by using the Assign form rules for the web, with the
Checkbox and Radio Button elements, which now support form rules.

Assign dynamic values with support for new elements in your forms
When you use the interactive forms package, you can now assign dynamic values with the Assign
action, which now supports Checkbox and Radio Button elements in your form.
You can also change the label of the selected form elements with the Change label action for the
Button element.
Interactive forms package on page 1638

IQ Bot

What's new

Search for form or table fields
When creating a learning instance, when you are configuring fields, you can now search for fields
by field name, field label, or data type.

Note sulla versione Automation 360 v.25 Community Edition
Data di rilascio: 21 giugno 2022

Scopri le nuove funzioni nella Community Edition della versione Automation 360 v.25 (Build 14304).
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Importante:  Questa versione include un aggiornamento di Bot Agent facoltativo. You can continue to
run your existing bots without updating the Bot Agent. However, if you want to use the new features in
Automation 360 v.25, you must update the Bot Agent available with this release.

Per informazioni sull'aggiornamento a questa versione, consulta le seguenti risorse:
• Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina

1043
• Compatibility with release builds alla pagina 1026

RPA Workspace

Novità

Supporto per automatizzare le applicazioni supportate dall'app Citrix Workspace (ID
caso Service Cloud: 01758063)
The Citrix Workspace app is now supported on Automation 360. You can now automate applications
that are accessed through the Citrix Workspace app by using the Recorder > Capture action or
the Start recording option.

Installazione di Bot Agent su dispositivi con Enterprise Client Enterprise 11
Quando si crea un bot in Automation 360, è possibile installare il Bot Agent su un dispositivo con un
Enterprise Client Enterprise 11 esistente. È possibile creare o eseguire bots da entrambe le istanze
di Control Room.
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039

Il banner di notifica di IE 11 EOL viene visualizzato in Control Room
A partire dalla versione v.25 di Automation 360, se si utilizza il browser Microsoft Internet Explorer
per accedere alla Control Room, verrà richiesto di utilizzare browser alternativi supportati come
Google Chrome o Microsoft Edge (Chromium). Quando si accede alla Control Room, viene
visualizzato un banner di notifica che indica che il supporto di Internet Explorer 11 sta per
terminare.
Accesso alla Automation Anywhere Control Room alla pagina 1022

AISense Recorder: Supporto per la lingua coreana e per le operazioni complesse sulle
tabelle
• Ora è possibile utilizzare il AISense Recorder per automatizzare le applicazioni che usano il

coreano e una combinazione di interfacce coreane e inglesi.
AISense per la registrazione di attività da applicazioni remote alla pagina 1965

• Con AISense Recorder, è possibile estrarre dati tabellari da tabelle complesse. Puoi acquisire
e automatizzare tabelle con colonne più ampie e tabelle con colonne in cui sono presente
comandi, come caselle di controllo o pulsanti di opzione. È inoltre possibile acquisire specifiche
colonne dalle tabelle.

Nota:  Se la tabella non viene rilevata automaticamente, utilizzare il comando Definisci per
rilevarla.

Table data extraction through AISense Recorder alla pagina 1979
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Novità

Miglioramenti a Recorder
• Quando si esegue un bot, è ora possibile automatizzare gli oggetti che appaiono dietro la

finestra del tempo di esecuzione del bot utilizzando l'action Registratore > Acquisisci. (ID
caso Service Cloud: 00684306, 00770636, 01146672)

• Ora puoi utilizzare il Recorder per acquisire e automatizzare oggetti con una tecnologia specifica.
La scheda Acquisisci oggetto ha ora l'opzione di selezionare una tecnologia specifica e di
eseguire l'acquisizione utilizzando quella tecnologia. Puoi acquisire oggetti con le seguenti
tecnologie:
• Microsoft Active Accessibility (MSAA)
• UI automation
• Microsoft (MS) COM UI Automation

Capture using specific technology alla pagina 1770
(ID caso Service Cloud: 01760871, 01865823

• You can now use the Recorder to automate third-party plug-in window objects on Google
Chrome or Microsoft Edge browsers by using a specific technology.

Opzione Riduci perdita di dati nei PDF package
Nell'action PDF > Testo estratto, per il Testo strutturato un nuovo campo di tipo Riduci
perdita dati è ora disponibile. Utilizzando questa opzione, è possibile estrarre il testo completo con
una sovrapposizione minima di caratteri.
Using Extract text action from PDF alla pagina 1735

Miglioramenti al package String (ID caso Service Cloud: 00770822)
Nell'action Stringa > Estrai testo, è ora disponibile la nuova opzione Durante l'estrazione. È
possibile utilizzare questa opzione per specificare se la grafia del testo nella sottostringa estratta
deve corrispondere a quello della stringa di origine.
Using Extract text action of String package alla pagina 1883

Download dei file da URL che richiedono l'autenticazione NTLM (ID caso Service Cloud:
01189873)
Con il package Browser migliorato, è ora possibile scaricare file da URL che richiedono
l'autenticazione NTLM utilizzando l'action Browser > Scarica file.

Miglioramenti all'opzione di invio di più allegati nell'action Invia email (ID caso Service
Cloud: 00800976, 00817136, 00821405, 00936080, 01256523, 01256320, 01262069, 01259369,
00936080, 01801928)
Quando si invia un'e-mail dai bots, è ora possibile inviare più allegati sotto forma di un elenco di file
o una variabile contenente l'elenco degli oggetti file. Grazie a questa funzione, è possibile allegare
all'e-mail file quali file di dati, fogli di calcolo e documenti di elaborazione del testo. È possibile
allegare più percorsi di file da un'unità locale o di rete, oppure utilizzare una variabile contenente un
percorso di file.
Utilizzo di Invia action alla pagina 1512
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Novità

Miglioramenti al SOAP Web Service package
Quando si costruisce una risposta SOAP per un'espressione Xpath nel package SOAP Web Service, il
risultato dell'espressione Xpath può essere memorizzato sotto forma di un elenco di stringhe.
Esempio di utilizzo dell'azione Servizio Web SOAP alla pagina 2076

Visualizzazione della cronologia delle versioni delle dipendenze dei file non-bot (ID caso
Service Cloud: 01615105)
Ora puoi visualizzare la cronologia delle versioni delle dipendenze dei file non bot. In questo modo
puoi identificare le modifiche apportate al file da altri utenti in una data e ora specifiche, insieme ai
messaggi di archiviazione.
View version history of non-bot file dependencies alla pagina 2049

Modifica dei nomi delle cartelle non vuote nell'area di lavoro privata (ID caso Service
Cloud: 00535388, 00730075, 00786633, 00791528, 01615295, 01820406)
Ora puoi modificare i nomi delle cartelle non vuote nell'area di lavoro privata. Grazie a questa
funzione, puoi gestire le cartelle in modo più semplice. Quando rinomini una cartella, accertarti di
quanto segue:
• Non deve contenere bots estratti o clonati, anche a livello di sottocartelle.
• Non deve contenere più di 100 elementi, comprese le sottocartelle e i file.

Crea e rinomina le cartelle alla pagina 2018

Visualizzazione delle mappe di dipendenza per i bots
Ora puoi visualizzare la mappa delle dipendenze per il tuo bot sia nell'area di lavoro pubblica che
in quella privata. La mappa delle dipendenze mostra i bots padre e figlio immediati per ogni bot
selezionato. Se sei uno sviluppatore RPA, puoi usare la mappa delle dipendenze per capire meglio
dove un bot viene invocato e quali bots figlio sono invocati dal bot. Grazie a queste informazioni,
puoi valutare l'impatto della variazione di un bot, utilizzare in modo efficace il bot, garantire un
codice e una capacità di riutilizzo del bot migliori e prevenire i conflitti.
View bot dependency map alla pagina 2008

Automation Anywhere Robotic Interface (AARI)

Novità

Creazione di una richiesta in una nuova scheda
È ora possibile aprire ed eseguire le nuove richieste in una scheda separata selezionando l'opzione
Apri richiesta in una nuova scheda nel modulo iniziale. Con questa opzione, è possibile creare
simultaneamente richieste senza modificare la navigazione nella pagina corrente.
Crea una richiesta e completa un'attività alla pagina 2163

Righe duplicate per l'elemento Tabella
Nell'interfaccia Web, quando si aggiungono righe al modulo utilizzando l'elemento Tabella, è ora
possibile risparmiare tempo duplicando una riga della tabella con la nuova opzione Duplica riga.
La riga duplicata verrà ora posizionata sotto la riga evidenziata selezionata.
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Novità

Supporto a ulteriori tecnologie per i trigger interfaccia
È ora possibile utilizzare i trigger interfaccia con le seguenti tecnologie:
• Windows nativo
• Desktop SAP
• Browser Google Chrome ed Edge Chromium

Add an interface trigger alla pagina 2213

Miglioramenti alle regole dei moduli
• Utilizzo della formattazione personalizzata

Quando si aggiunge una regola, se si utilizza il menu Se per impostare le condizioni della
regola su determinati elementi, ad esempio Casella di testo o Area testo, è ora possibile
selezionare È dal menu a discesa per attivare altre opzioni. Select the Custom option and click
Add regular expression to apply custom formatting requirements on the selected element.
Si consideri uno scenario in cui gli ID utente di tutti i dipendenti hanno come prefisso AV. Ad
esempio, per un dipendente il cui nome è Adam, l'ID utente è AVAdam. Utilizzare l'opzione
Aggiungi espressione regolare per impostare il valore nel campo Espressione regolare
come ^AV. Se un utente inserisce Adam nel campo ID utente, appare un avviso.

• Impostazione di un valore personalizzato o aggiunta di un valore di elemento
Quando si aggiunge una regola, utilizzare il menu Quindi per selezionare un elemento modulo.
Per questo elemento modulo, è possibile impostare una delle azioni corrispondenti usando
Imposta valore o Aggiungi valore:
• Valore: I dati inseriti nel campo Inserisci valore vengono applicati all'elemento

selezionato.
• Elemento modulo: I dati dell'Elemento modulo selezionato nel menu a discesa Seleziona

elemento vengono aggiunti.

Si consideri uno scenario in cui un modulo di registrazione utente contiene i campi "Nome" e
"ID dipendente". È possibile impostare una delle seguenti regole per il valore del campo ID
dipendente:
• Selezionare Valore e inserire Emp1013 come valore preimpostato.

Questo valore viene visualizzato nel campo "ID dipendente" durante l'esecuzione del bot.
• Selezionare Elemento modulo e impostare l'elemento "Nome" nel menu a discesa

Seleziona elemento.
Il valore del campo "Nome" viene aggiunto al campo "ID dipendente" quando il bot viene
eseguito.

Puoi usare gli elementi nello stesso modo in cui utilizzi le variabili in Bot editor. Puoi inserire $
per visualizzare un elenco di elementi.

Aggiunta di regole agli elementi di un modulo alla pagina 2202

Document Automation

IQ Bot Extraction360 (Anteprima) è ora Document Automation. Community Edition consente agli utenti
di provare le funzionalità di Document Automation, tra cui la creazione di un massimo di cinque istanze
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di apprendimento, la connessione alle istanze di apprendimento in Automation 360 IQ Bot, caricare
documenti per l'elaborazione e convalidare i documenti con Gestione attività AARI.
Community Edition alla pagina 2467

Cosa è cambiato

La cartella Spazio di lavoro del documento contiene ora le risorse dell'istanza di apprendimento
(bots, processo e modulo). In precedenza, queste risorse si trovavano nella cartella Processi IQ
Bot.

Le actions che supportano l'elaborazione dei documenti si trovano ora nel package Document
Extraction. In precedenza, queste actions si trovavano nel package IQ Bot Extraction360
(Anteprima).

Le istanze di apprendimento delle versioni precedenti sono state eliminate per consentire
l'aggiornamento a Build 14304.

Limitazioni

Document Automation supporta un nome utente dispositivo di 21 caratteri o meno.

The value beside the Validate documents link, which indicates the number of documents
awaiting validation for a learning instance, sometimes does not appear.

When you are validating a document, if you draw a box, zoom in, and then click Fit to screen, the
box appears at a different location from where you clicked.

Se ti connetti a un'istanza di apprendimento da Automation 360 IQ Bot con un campo facoltativo
che ha un valore predefinito e alcuni campi non mappati, quando elabori i documenti in
quell'istanza di apprendimento in Document Automation, il valore predefinito appare nei campi non
mappati.

When a bot runs an action from the Document Extraction package, the Activity > In progress
page shows the item name as IQBotAutoExtract.

Sebbene la pagina delle istanze di apprendimento indichi che gli utenti non possono cancellare
istanze di apprendimento, un utente può cancellare un'istanza di apprendimento passando il mouse
sul menu delle azioni a destra dell'istanza di apprendimento e facendo clic sull'icona Elimina.

Note sulla versione Automation 360 v.24 Community Edition
Data di rilascio: 22 marzo 2022

Scopri le nuove funzioni nella Community Edition della versione Automation 360 v.24 (Build 12350).

Nota:  Per informazioni sulla patch v.24R2 Automation 360 per Community Edition, vedi Note sulla versione
di v.24R2 Automation 360 per EOL Internet Explorer 11 alla pagina 259.

RPA Workspace

Importante:  Questa versione include un aggiornamento di Bot Agent facoltativo. Per utilizzare le nuove
funzionalità della versione v.24 (compresi gli aggiornamenti ai packages Migrazione Bot, Browser, DLL,
Process Discovery e Recorder), aggiorna l'Bot Agent disponibile con questa versione. Tuttavia, se desideri
eseguire i bots esistenti, non aggiornare l'Bot Agent a questa versione.
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Per informazioni sull'aggiornamento a questa versione, consulta le seguenti risorse:
• Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina

1043
• Compatibility with release builds alla pagina 1026

Novità

Ulteriori operazioni con Microsoft Edge Chromium
Ora è possibile utilizzare l'estensione per il browser Microsoft Edge Chromium per quanto segue:
• Configurazione del proxy Bot Agent
• Popolamento automatico delle credenziali del dispositivo

Requisiti del browser per RPA Workspace alla pagina 866

Riduzione dei tempi di risposta
Ora puoi ridurre i tempi di risposta per la raccolta delle informazioni relative ai problemi grazie
all'acquisizione di file di log dal dispositivo Bot Runner. Puoi salvare i file di registro utilizzando il
nuovo comando -collectlogs con l'utilità di diagnostica Bot Agent.
Esecuzione di controlli diagnostici Bot Agent alla pagina 1048

Miglioramenti al AISense Recorder
Ora è possibile utilizzare AISense Recorder per automatizzare le applicazioni che usano il
giapponese e una combinazione di interfacce giapponesi e inglesi.
AISense per la registrazione di attività da applicazioni remote alla pagina 1965

Supporto per la copia di metadati da un bot a un altro
È ora possibile copiare file di immagini e metadati da un bot all'altro usando l'opzione Copia negli
appunti condivisi.

Opzione di tempo di attesa nei packages SOAP Web Service e REST Web Service  (ID
caso Service Cloud: 00756730, 00792793, 01255869, 01753287)
Quando si crea un bot, è ora possibile impostare un valore di timeout per le actions nelle richieste
REST e SOAP. Per indicare il tempo per cui un bot dovrebbe attendere una risposta dal server
prima del timeout, è possibile impostare un tempo di attesa (in millisecondi) nel campo Attendi il
completamento delle azioni. È possibile inserire un numero o una variabile o fornire un valore
globale.

Formattazione del testo con il nuovo editor HTML nel package Email
Nel package Email, quando si utilizzano le actions Invia, Rispondi e Inoltra, è ora possibile
creare e personalizzare il layout e il corpo delle e-mail utilizzando il nuovo editor di design HTML.
Usa la barra degli strumenti dell'editor per apportare modifiche al testo, come applicare il grassetto,
il corsivo e altri effetti di formattazione, inserire collegamenti e cambiare il carattere e le dimensioni
del testo. È possibile copiare il contenuto dall'editor di design e incollarlo in altre finestre.

Il package Task Bot ora supporta il passaggio della variabile Finestra al bot figlio (ID
caso Service Cloud: 00691890, 00804359, 01258948, 01764292)
Nell'action Esegui del package Task Bot, quando si selezionano i campi Valori di input e si
immettono i valori o le variabili da passare al bot figlio, è ora possibile scegliere la variabile tipo
Window e passarla dal bot padre al bot figlio.
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Novità

Nuova opzione nel campo Tipo di contenuto del package REST Web Service (ID caso
Service Cloud: 00666852, 00789910, 00771194, 00785116, 00825945, 01762199)
Ora è possibile utilizzare l'opzione multiparte/dati modulo per caricare file e dati tramite REST
Web Service. Il tipo di contenuto multiparte/dati-modulo può essere usato per inviare elementi di
modulo contenenti file, dati non-ASCII e dati binari. Questa opzione è disponibile per actions come
POST, PUTe PATCH.

Opzione delimitatore personalizzato nel package SOAP Web Service
Per risposte specifiche a XPath, è ora possibile utilizzare l'opzione delimitatore personalizzato per
delimitare il contenuto di ritorno dalla risposta SOAP. Nel campo Delimitatore personalizzato, è
possibile immettere un carattere o una variabile e l'output della risposta delimitata sarà una stringa
completa.

Nuova opzione nell'action Esegui funzione del package DLL (ID caso Service Cloud:
00830568, 01063654, 01259336, 01767965)
Nell'action Esegui funzione del package DLL, quando la DLL C# interagisce con l'API di Windows
per eseguire operazioni relative al sistema, come la pressione dei tasti, il clic del mouse o il cambio
di finestra, viene visualizzata occasionalmente una finestra intermedia (AAZeroSizeForm) che
interrompe l'operazione dell'utente quando il bot è in esecuzione. In alcuni casi, la funzione DLL
non interagisce con l'API di Windows per eseguire actions come la pressione di un tasto, il clic del
mouse o il cambio di finestra, sull'interfaccia utente del sistema operativo attraverso la funzione
DLL. In questi casi, è possibile selezionare la casella di controllo Esegui funzione in background
per bypassare la finestra intermedia (AAZeroSizeForm) ed eseguire la DLL C# nell'applicazione
console senza il modulo. Questa funzionalità aiuta anche a migliorare le prestazioni di esecuzione
della DLL se la casella di controllo Esegui funzione in background è selezionata.

Scorrimento automatico supportato in Bot editor (ID caso Service Cloud: 00730747)
Quando si creano o modificano bots con un gran numero di righe di codice e quando si trascinano
actions su e giù per la pagina, la pagina scorre ora automaticamente verso l'alto o verso il basso di
conseguenza. Questa funzionalità è supportata in entrambe le viste Flusso ed Elenco.

Nuovo package JSON
Utilizza il package JSON per automatizzare i dati JSON. È ora possibile estrarre le informazioni
richieste dal testo o dal file JSON e utilizzare direttamente i valori nel bot.
package Json alla pagina 1666

Nuova opzione nell'action Cattura del package Error handler (ID caso Service Cloud:
00766117)
Nel package Error handler, ora puoi ignorare gli errori delle actions all'interno del blocco Cattura
utilizzando l'opzione Cattura > In caso di errore, continua con l'azione successiva. Quando
selezioni la casella di controllo In caso di errore, continua con l'azione successiva, anche se
esiste un errore da un'action nel blocco Cattura, non viene lanciata alcuna eccezione e il bot ignora
l'errore e continua con l'azione successiva.

Nota:  Questo miglioramento si applica a tutte le actions contenute all'interno del blocco Cattura.
Per esempio, se esiste un'action Prova/Cattura all'interno dell'action Cattura principale e
la casella di controllo dell'action Cattura principale è selezionata, qualsiasi errore da actions
all'interno del blocco annidato sarà ignorato.
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Miglioramento del package Stringa
Nell'action Estrai testo del package Stringa ,quando si usa l'opzione Dopo o Prima e/o dopo, è
ora possibile estrarre una sottostringa da una stringa sorgente specificata presente tra 1 e 999999
volte in un file.

Ricerca di file per data specifica
È ora possibile cercare i file creati o modificati in una data specifica utilizzando la nuova opzione In
data disponibile nella condizione Data file di vari packages.
Puoi usare questa funzione con i seguenti packages e actions:
• File package

• Copia file desktop action
• Elimina action
• Stampa action
• Stampa più file action
• Rinomina action

• package cartella
• Copia action
• Elimina action
• Rinomina action

• If > Condizione di data del file
• Loop > While > Condizione di data del file

Nuova action nel package Excel advanced (ID caso Service Cloud: 01263892, 01782290)
Quando si eseguono actions in un foglio di lavoro di Microsoft Excel, è ora possibile disabilitare o
abilitare l'aggiornamento della schermata in tempo reale utilizzando la nuova action Disabilita o
abilita l'aggiornamento dello schermo in tempo reale del package Excel advanced. Questa
action è utile per migliorare le prestazioni delle automazioni basate su Excel in fase di esecuzione
quando si tratta di grandi insiemi di dati.
Worksheet operations in Excel advanced alla pagina 1542

Utilizzo delle condizioni Recorder in Microsoft Edge basato su Chromium con modalità
Internet Explorer (IE)
Ora puoi utilizzare le condizioni Recorder L'oggetto esiste e L'oggetto non esiste in Microsoft
Edge basato su Chromium con modalità IE per i seguenti packages:
• Loop > Condizione While
• Wait > Condizione Attendi
• If package
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Novità

Supporto del browser Internet Explorer per il package Browser e le variabili finestra
• Le seguenti actions del package Browser ora supportano il browser Internet Explorer:

• Apri
• Chiudi
• Vai indietro
• Ottieni codice sorgente

• Nell'opzione Browser, è ora possibile selezionare le schede Internet Explorer dall'elenco delle
schede attive.

Browser package alla pagina 1425

Miglioramenti al Datetime package
L'opzione Variabile nell'action Data/ora > Assegna è ora migliorata e suddivisa in due opzioni:
• Data/ora: Permette di selezionare manualmente la data e l'ora insieme al fuso orario e di

assegnarli a una variabile Data/ora.
• Variabile: Permette di selezionare la variabile Datetime o altre variabili che possono avere

Datetime come sottotipo, come le variabili Dizionario, Record ed Elenco.

Utilizzo dell'azione Assegna alla pagina 1473

Miglioramenti al Recorder package
È ora possibile acquisire e automatizzare gli oggetti all'interno di un IFrame interdominio che ha
più IFrame con la stessa origine del frame e IFrame caricati in fase di esecuzione nei browser
Chromium Google Chrome e Microsoft Edge. Puoi farlo utilizzando Registratore > Acquisisci
o l'opzione Avvia registrazione. Questo supporto è disponibile anche per le estensioni Google
Chrome offline.
Pacchetto Recorder alla pagina 1751

Supporto per finestre a comparsa e finestre di dialogo nel browser Google Chrome,
Microsoft Edge Chromium e Mozilla Firefox (ID caso Service Cloud: 00762207, 00769773,
00781196, 00786646, 00777907, 00795677, 00785995,00808600, 00811044, 00767486, 01282172,
01286665, 01256750, 01762040)
Durante l'automazione di una pagina Web sui browser supportati, ora puoi acquisire finestre pop-
up, finestre di dialogo di avviso, finestre di dialogo di conferma e finestre di dialogo di richiesta.
Puoi farlo utilizzando Registratore >  Acquisisci o l'opzione Avvia registrazione.
Pacchetto Recorder alla pagina 1751

Recupero del codice sorgente di un iFrame nel browser Google Chrome
Ora puoi estrarre il codice sorgente di un iFrame nel browser Google Chrome utilizzando l'action
Browser > Ottieni codice sorgente. Per acquisire questi iFrame, puoi utilizzare la nuova opzione
Acquisisci oggetto.

Nota:  La funzionalità Acquisisci oggetto è facoltativa e viene utilizzata solo per acquisire il
codice sorgente di un iFrame.
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Esegui JavaScript all'interno di un iFrame nel browser Google Chrome
Ora puoi eseguire JavaScript in una pagina che contiene iFrame nel browser Google Chrome
utilizzando l'action Browser >  Esegui JavaScript. Puoi utilizzare la nuova opzione Acquisisci
oggetto per acquisire gli iFrame sui quali desideri eseguire JavaScript.

Nota:  La funzionalità Acquisisci oggetto è facoltativa e viene utilizzata solo per eseguire
Javascript all'interno di un iFrame.

Supporto di Sessione globale per il package Excel basic
• L'opzione Sessione globale è ora supportata per il package Excel basic. Utilizza l'opzione

Sessione globale per condividere una sessione di Microsoft Excel tra più bots in modo da poter
utilizzare lo stesso foglio di lavoro Excel tra questi bots.

• Il campo Nome sessione esistente è ora rinominato Crea sessione Excel.

Using the Open action for Excel basic alla pagina 1531

Variabile predefinita per il contenimento di dati di tipo numerico
Quando si realizza o si testa un bot, ora è possibile utilizzare la variabile numerica predefinita
SampleNumber, inclusa nella tavolozza Variabili.

Nota:  La variabile numerica predefinita è disponibile solo nei nuovi bots.

Esportazione e importazione di file protetti da password
Per migliorare la sicurezza fornendo protezione contro l'accesso non autorizzato e la modifica
malevola e proteggere inoltre la privacy, le funzioni di esportazione e importazione sono state ora
migliorate per includere l'opzione password. Con questa funzionalità puoi ora eseguire le operazioni
seguenti:
• Impostare una password per i file che vuoi esportare dalla tua Control Room.
• Importare il file esportato protetto da password nella tua Control Room.

Esporta bots alla pagina 2835 | Importa bots alla pagina 2837

Nuove opzioni in configurazione Git (ID caso Service Cloud: 00782957, 00837059, 00687394,
00783715, 00714059, 00659476, 00749755, 00786233, 00748166, 00776417)
Ora puoi eseguire le azioni seguenti per la configurazione Git:
• Scegliere il metodo di autenticazione HTTPS o SSH per impostare la configurazione Git. Il

metodo di autenticazione SSH è più sicuro perché l'autenticazione è basata su una coppia di
chiavi pubbliche e private.

• Specificare il ramo in cui vuoi spingere i tuoi commit di Git. Questo aiuta il coordinamento del
team e la gestione del flusso di lavoro.

• Connettiti all'archivio Git tramite un server proxy.

Configure a remote Git repository in Control Room alla pagina 2754 | Ripristino di bots da archivio Git
alla pagina 2761
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Automation Anywhere Robotic Interface (AARI)

Novità

Microsoft Edge Chromium e Safari supportati per AARI
Ora è possibile creare moduli e processi in RPA Workspace ed eseguire richieste, attività e bots
nell'interfaccia web su Microsoft Edge Chromium e Safari.
Requisiti del browser per RPA Workspace alla pagina 866

Creazione di campi con password e occultamento di informazioni sensibili (ID caso
Service Cloud: 00714159, 01063512)
In RPA Workspace, è ora possibile creare campi password utilizzando l'elemento Password nel
proprio generatore di moduli. È possibile utilizzare l'elemento Password nell'interfaccia web per
aggiungere del testo mascherato ai campi password nei moduli iniziali per nascondere informazioni
sensibili.
Configura i processi alla pagina 2121 | Proprietà dell'elemento password alla pagina 2155

Miglioramento dell'ID di riferimento alle richieste
Ora è possibile visualizzare l'ID di riferimento associato al processo nella colonna Riferimento della
pagina Richieste. L'ID di riferimento è una combinazione di un prefisso e un numero creata da una
Chiave di processo che è possibile inserire quando il processo viene modificato per la prima volta.
Questo ID di riferimento viene incrementato ogni volta che viene creata una richiesta dal processo
corrispondente.
Proprietà dell'ID di riferimento alla pagina 2159 | Configure an AARI process alla pagina 2175

Stato Annullata per le attività
È ora possibile filtrare le attività in base allo stato Annullata nella pagina Attività. Questo stato
mostrerà l'etichetta Annullata accanto ai risultati filtrati per informarti delle attività che sono state
annullate da un utente. Puoi filtrare questo stato dal menu a discesa nella barra di stato.
Filtrare e cercare un'attività alla pagina 2170

Riempimento degli elementi iniziali del modulo tramite parametri URL
Quando si crea una richiesta, è ora possibile riempire gli elementi iniziali del modulo creando script
di query che inseriscono parametri specifici nell'URL iniziale del modulo. Questi parametri sono
applicabili solo per gli elementi Data, Numero, Casella di testo e Ora.
Parametri URL alla pagina 2153
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Personalizzazione del testo nei moduli usando gli aggiornamenti dell'elemento
Etichetta
Ora è possibile personalizzare il testo nei tuoi moduli in vari modi, come applicare il grassetto, il
corsivo, il sottolineato e altri effetti di formattazione, cambiare la dimensione e il colore del carattere
e così via, usando l'elemento Etichetta. Con queste opzioni, è possibile evidenziare messaggi o
testi specifici, come passi successivi, avvertimenti o errori, quando rappresentati nel modulo iniziale
nell'interfaccia web.
L'elemento Etichetta offre ora le opzioni di formattazione seguenti:
• Enfasi
• Colore carattere
• Dimensioni carattere
• Allineamento del testo

Utilizzo dell'elemento Etichetta alla pagina 2196

Ricerca e filtro di colonne in una tabella
Nella schermata del generatore del modulo, se si seleziona la casella di controllo Abilita il
filtraggio delle colonne per l'elemento Tabella, gli utenti possono cercare e filtrare il contenuto
per tutte le colonne disponibili quando il bot è in esecuzione.
Quando si usa l'elemento Tabella per riportare una tabella nei moduli iniziali, si dispone ora della
capacità migliorata di eseguire la ricerca su ogni colonna della tabella per valore.
Utilizzo dell'elemento Tabella alla pagina 2200

Discovery Bot

Novità

Salvataggio della registrazione con un nome
Dopo aver registrato un processo, è possibile ora salvare la registrazione con un nome. Il nome
della registrazione viene visualizzato nella pagina Registrazioni  per il suddetto processo.
Registrare un processo aziendale Discovery Bot alla pagina 2348

Condivisione di una descrizione della registrazione
È ora possibile fornire una descrizione per la registrazione di un processo utilizzando la pagina
Registrazioni per il suddetto processo. Nella pagina Registrazioni, utilizza il campo Descrizione
per condividere con l'analista il contesto e lo scopo della registrazione. La descrizione fornita viene
visualizzata anche nel PDD.
Registrare un processo aziendale Discovery Bot alla pagina 2348

Eliminazione di una registrazione
Dopo aver registrato un processo, se non si desidera sottoporre i dati della registrazione a un
analista per la revisione, è possibile eliminare la registrazione usando la pagina Registrazioni
del processo in questione. Nella pagina Registrazioni, utilizza l'opzione Elimina per eliminare la
registrazione.
Registrare un processo aziendale Discovery Bot alla pagina 2348
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Registrazione dei processi aziendali con AARI Assistant
Ora è possibile utilizzare AARI Assistant per registrare i processi aziendali senza accedere alla
Control Room. Per registrare un processo aziendale, avviare AARI Assistant facendo doppio clic
sull'icona AARI sul desktop.
Registrazione di processi Discovery Bot con AARI Assistant alla pagina 2353

Miglioramenti alle opportunità personalizzate
Ora puoi aggiornare i costi e i risparmi potenziali per le opportunità personalizzate e salvare le
tue modifiche al diagramma di processo. I costi e i risparmi potenziali possono essere aggiornati
in qualsiasi momento, man mano che si rivedono i passi delle varie registrazioni e si apportano
cambiamenti all'interno del diagramma di processo.
Esame delle opportunità, conversione in bot e creazione di PDD alla pagina 2355

Miglioramento del PDD
Ora è possibile visualizzare l'intero diagramma di processo dall'interno del Discovery Bot facendo clic
sul link URL fornito nel PDD. Il PDD non visualizza il diagramma di processo se sono selezionati più
di 100 passi.
Esame delle opportunità, conversione in bot e creazione di PDD alla pagina 2355

Correzioni

ID caso Service Cloud Descrizione

-- Nella versione Community Edition e nella versione Free Trial, ora
puoi creare ed eliminare cinque o più processi e l'opportunità
di autogenerazione non genera errori. Puoi creare fino a cinque
opportunità.

Note sulla versione Automation 360 v.23 Community Edition
Data di rilascio:30 dicembre 2021

Review what's new in the Community Edition of the Automation 360 v.23 (Build 11524) release. Build
11524 replaces Build 11513.

Importante:  Build 11524 includes a fix for the issue of frequent device disconnections caused by either
high load or the database being locked.

RPA Workspace

Importante:  This release includes a required update to your . Ensure that you complete the update to
continue with your automation activities when upgrading from a previous release to this release.
Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina
1043
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To verify which  version is compatible with this release, see Compatibility with release builds alla pagina
1026.

Novità

Microsoft Edge (Chromium) supportato per Control Room e Bot Agent
È ora possibile eseguire operazioni di Control Room e installare e registrare il proprio dispositivo Bot
Agent usando Microsoft Edge basato sul browser Chromium.
Requisiti del browser per RPA Workspace alla pagina 866

Supporto per l'automazione di Microsoft Edge Chromium con modalità di compatibilità
Internet Explorer (ID caso Service Cloud: 00767502, 00787186)
È ora possibile automatizzare le applicazioni web in esecuzione su Microsoft Edge Chromium,
abilitando la modalità di compatibilità Internet Explorer, utilizzando il Universal Recorder dove gli
oggetti vengono acquisiti utilizzando la tecnologia HTML.
Record a task with the Universal Recorder alla pagina 1951

Supporto per iFrame interdominio nei browser Google Chrome e Microsoft Edge
Chromium (ID caso Service Cloud: 00825656)
Ora è possibile acquisire e automatizzare gli oggetti all'interno di un iFrame interdominio nei
browser Google Chrome e Microsoft Edge Chromium utilizzando Registratore > Acquisisci
o l'opzione Avvia la registrazione. Dopo aver acquisito un oggetto all'interno di un IFrame
interdominio, il percorso del frame è memorizzato, per impostazione predefinita, nella proprietà
FrameDOMXPath.
La nuova proprietà FrameDOMXPath identifica il percorso del frame in cui si trova l'oggetto. È
necessario selezionare questa proprietà per eseguire il bot con successo per acquisire oggetti su un
IFrame interdominio.

Nota:  Questa funzionalità è disponibile per i bots creati utilizzando dalla versione
2.4.0-20211016-070100 del package Recorder in poi.

Pacchetto Recorder alla pagina 1751

Supporto per l'ancora di cattura in AISense Recorder
AISense Recorder supporta ora l'opzione Acquisisci ancoraggio. Quando si esegue un bot
per cercare un oggetto in un'applicazione in cui l'ancoraggio cambia frequentemente, è possibile
utilizzare Acquisisci ancoraggio per sovrascrivere l'ancoraggio predefinito e selezionarne
manualmente uno per rilevare l'oggetto.
Edit a task recorded using AISense alla pagina 1969

Supporto migliorato quando si seleziona la proprietà Oggetto nel package Recorder
Dopo aver acquisito un oggetto utilizzando l'action Registratore > Acquisisci, ora puoi
selezionare il nome di una particolare proprietà dell'oggetto dall'elenco delle proprietà disponibili
per recuperare il valore della proprietà dell'oggetto utilizzando l'action Ottieni proprietà. L'elenco
include i nomi di proprietà suggeriti dai criteri di ricerca nella tabella Proprietà oggetto.
Pacchetto Recorder alla pagina 1751
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ID file supportato nell'action Verifica autorizzazione del package Google Drive (ID caso
Service Cloud: 00777716)
L'action Verifica autorizzazione del package Google Drive supporta ora l'opzione ID file per fare
riferimento ai file disponibili nella cartella Condiviso con me di Google Drive. Fornendo l'ID file,
ora puoi verificare l'accesso Leggi, Scrivi o Elimina concesso nella cartella Condiviso con me
dei file di Google Drive.
Pacchetto Google Drive alla pagina 1602

Nuove credenzialipackage
Ora puoi usare l'action Assegna nel package credenziali per assegnare una stringa non sicura o
una variabile direttamente alla variabile credenziali.
package Credenziale alla pagina 1436

Sicurezza dei servizi Web supportata nel package SOAP Web Service (ID caso Service
Cloud: 00481836)
Come Bot Creator, è ora possibile fornire variabili di credenziali nei dati non elaborati dell'action
Servizio Web SOAP. Puoi creare una variabile credenziali, mappare le credenziali con un nome di
riferimento nel mapper di credenziali e usare il nome di riferimento nei dati non elaborati. Poiché
questo assicura che tutti i dati relativi alla sicurezza possano essere definiti nel Credential Vault e
le credenziali possano essere usate nei bots, è possibile distribuire tranquillamente le attività senza
compromettere la sicurezza.
Esempio di utilizzo dell'azione Servizio Web SOAP alla pagina 2076

Nuova opzione nel package SOAP Web Service
Utilizza l'opzione Crea Xpath nel package SOAP Web Service per estrarre i valori dalla risposta
SOAP. È ora possibile specificare l'espressione Xpath o selezionare il nodo appropriato dal corpo
della risposta e memorizzare l'output in una variabile.

Lettura di e-mail dalla casella di posta condivisa in Microsoft Outlook (ID caso Service
Cloud: 00728579, 00831622)
Per automatizzare le attività legate alla posta elettronica, è ora possibile selezionare un account
condiviso in Microsoft Outlook in modo che i messaggi e-mail possano essere letti dalla casella di
posta condivisa.

Nuovi tipi di codifica supportati nell'action Scrivi su file del package Data Table (ID caso
Service Cloud: 00767158)
Quando si utilizza l'action Scrivi su file per scrivere i dati da una variabile di tipo Tabella in un file
CSV o TXT, è ora possibile utilizzare i seguenti tipi di codifica dall'elenco di codifica:
• UTF-8: Funziona come UTF-8 senza BOM
• UTF-8 con BOM (in precedenza UTF-8)
• UTF-16LE
• Maiusc-JIS (codifica giapponese)
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Funzionalità di salvataggio automatico in Bot editor
In Bot editor, quando si utilizzano actions per creare un'automazione, quando un bot non viene
salvato manualmente, viene eseguito un salvataggio automatico e il bot salva ora automaticamente
le modifiche per eventi specifici.

Nota:  La funzionalità di salvataggio automatico è attualmente disponibile solo per eventi specifici.

Alcuni degli eventi che supportano la funzionalità di salvataggio automatico sono i seguenti:
• Registratore: Quando si crea un bot con determinate actions e si fa clic su Registratore,

l'evento viene salvato e al termine della registrazione l'evento viene salvato in modo automatico.
• Gestione variabili: Quando si crea o si modifica una variabile per inserirla in un'action, le

modifiche vengono salvate.

Nota:  La funzionalità di salvataggio automatico non è supportata quando si elimina una
variabile o la si inserisce premendo F2 per aprire l'elenco delle variabili.

• Menu Azioni (puntini di sospensione verticali): Quando si seleziona una qualsiasi action da
questo menu, per esempio Pacchetti, l'evento viene salvato automaticamente. Quando si
applica una qualsiasi modifica alla pagina Pacchetti e si ritorna al Bot editor, l'evento viene
salvato.

• Trova un file: Quando fai clic sull'icona Trova un file, il bot viene salvato se non è stato salvato
manualmente. Inoltre, dopo aver fatto clic sull'opzione Aggiungi, il bot viene automaticamente
salvato.

• Finestre di dialogo: Quando una finestra di dialogo viene aperta, questa viene automaticamente
salvata se vengono fatte delle modifiche.

Nota:  Il salvataggio automatico viene attivato solo per le finestre di dialogo di primo livello e
non per quelle annidate.

• Eliminazione di variabili: Quando si eliminano variabili inutilizzate, l'evento viene salvato.
• Modifica del nome di un Bot: Se si modifica il nome di un bot, l'evento viene salvato.

Nuova opzione nel FTP / SFTP package (ID del caso Service Cloud: 00792346)
Utilizza l'opzione Credenziali quando ti connetti con il tipo di server FTP sicuro per automatizzare
un'attività. Ora puoi usare nome utente e password per l'autenticazione.
Connect action alla pagina 1578

Miglioramenti al AISense Recorder
AISense Recorder supporta ora l'automazione di applicazioni che usano il portoghese brasiliano e
una combinazione di interfacce in portoghese brasiliano e inglese.
AISense per la registrazione di attività da applicazioni remote alla pagina 1965

Miglioramenti al package Numero
• Nell'action Casuale del package Numero, è possibile specificare e limitare il numero di cifre

decimali richieste nel numero casuale generato nell'output.
• Il campo Salva il risultato in una variabile numerica esistente è ora rinominato come

Salva il risultato in una variabile.

Number package alla pagina 1695
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Miglioramenti al package Attendi
Utilizza la nuova funzionalità Acquisisci regione nell'action Attendi la modifica della
schermata del package Attendi per acquisire una regione specifica in un'applicazione tracciando
un rettangolo intorno ad essa in modo che il bot acquisisca automaticamente le coordinate di
questa regione. Puoi effettuare le seguenti operazioni:
• Acquisire una regione specifica in un'applicazione Windows.
• Visualizzare un'anteprima dell'immagine acquisita nella finestra Anteprima.
• Riacquisire una regione se l'immagine nella finestra Anteprima non è conforme ai requisiti

dell'utente.

Le coordinate sono rinominate come segue:
• Sinistra è ora X
• In alto è ora Y
• Destra è ora Larghezza
• In basso è ora Altezza

Using Wait for screen change action alla pagina 1924

Miglioramento del package Stringa
Nell'action Estrai testo del package Stringa è ora possibile estrarre una sottostringa da una stringa
sorgente specificata che ricorre più di 1000 volte in un file con un limite massimo di 999999.

Miglioramento di Condizioni file nel package Se
È ora possibile usare la nuova condizione Estensione del file dall'elenco Condizione nel package
Se per controllare le estensioni dei file e poi eseguire le actions in base ai risultati.

Miglioramento a Excel advanced package (ID del caso Service Cloud: 00799071)
Usa l'action Apri del package Excel advanced per aprire i file con estensioni .ods, .htm, .html,
.mht, .mhtml, .slk e .pdf.
Excel advanced package alla pagina 1533

Supporto della sessione globale per l'iteratore del loop basato su Excel advanced
È ora possibile usare l'opzione Sessione globale quando si esegue un loop su ogni riga di un
foglio di lavoro Excel advanced. Utilizza l'opzione Sessione globale per condividere una sessione
di Microsoft Excel tra più bots in modo da poter utilizzare lo stesso foglio di lavoro Excel tra questi
bots.
Using the Open action for Excel advanced alla pagina 1539

Nuove API per i dispositivi
Ora puoi allocare i dispositivi predefiniti utilizzando le nuove API introdotte nella sezione v1/
Devices. Scegli di impostare o non impostare un dispositivo specifico come dispositivo di
distribuzione predefinito per un utente specificato utilizzando rispettivamente le seguenti API:
• /runasusers/default
• /runasusers/default/unset
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Automation Anywhere Robotic Interface (AARI)

Novità

Nuovo filtro di query nelle azioni Richieste di query e Attività query
Utilizza il nuovo filtro ora disponibile nelle actions Richieste di query e Attività query del
package Web AARI per filtrare le richieste e le attività di query per nome del team nell'interfaccia
Web AARI.

Filtro Nome del team
Puoi filtrare le attività e le richieste per nome del team rispettivamente nelle pagine Attività e
Richiesta nell'interfaccia Web. Seleziona l'etichetta Team dal filtro e ricerca per nome del team
per visualizzare i team assegnati a un'attività o a una richiesta.
Filter and search for a request alla pagina 2168 | Filtrare e cercare un'attività alla pagina 2170

Supporto per log di audit (ID del caso Service Cloud: 00801166)
Ora è possibile visualizzare i log di audit e fare riferimento agli eventi relativi a richieste, team,
pianificatore, configurazione del processo, impostazioni bot, attività umane e attività bot create,
eliminate, aggiornate, inviate o recuperate.
Log di audit alla pagina 2654

Miglioramento dell'assegnazione delle attività all'utente in Attività umana
Nell'editor di processo, l'opzione Assegna automaticamente quest'attività in Attività umana
offre le seguenti alternative:
• L'utente che ha creato la richiesta: L'attività viene automaticamente assegnata all'utente

che crea questa richiesta nell'interfaccia Web.
• L'utente che apre quest'attività: L'attività viene assegnata automaticamente all'utente che

apre l'attività nell'interfaccia Web.

Questa funzionalità aiuta a ridurre i conflitti nell'assegnazione di un'attività a se stessi, in particolare
nel caso di utenti specializzati come Validator per i quali l'azione di aprire un'attività equivale ad
assegnare l'attività a se stessi.
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Miglioramento della configurazione del team
È ora possibile aggiungere contemporaneamente più utenti con ruoli simili (ruolo personalizzato)
al team AARI nell'interfaccia Web. Il ruolo personalizzato nella Control Room è ora allineato con un
team nell'interfaccia Web AARI e la configurazione migliorata del team funziona come segue:
• Agli utenti aggiunti con il ruolo viene assegnato un ruolo Membro nel team. Il ruolo non può

essere cambiato in Proprietario o Admin.
• Non è possibile visualizzare questi utenti nella scheda Utenti della pagina Team.
• Se un utente è sia parte di un ruolo che aggiunto manualmente al team, il suo ruolo nel team

sarà lo stesso assegnatogli manualmente. Per esempio, se un utente è un membro, continuerà
ad avere il ruolo Membro mentre se l'utente è un proprietario, gli verrà assegnato il ruolo
Proprietario nel team.

• Se l'utente non fa più parte di un ruolo, non farà più nemmeno parte del team.

Inoltre, la pagina Team è ora migliorata con opzioni di navigazione nella parte superiore che
consentono di navigare attraverso le varie schede (Generale, Utenti, Ruoli, Processi e Bot).
Utilizza le schede Generale, Utenti e Ruoli per creare team e aggiungervi utenti. Le schede
Processi e Bot visualizzano rispettivamente i processi e i bots assegnati ai team.
Team management alla pagina 2157 | Creare un team AARI e assegnare i ruoli ai membri alla pagina
2164

Supporto per la configurazione dei bot
L'amministratore AARI può utilizzare la pagina Configurazione bot per visualizzare i bots
assegnati a un team, assegnare i team a un bot e modificare i bots per rimuovere o riassegnare
i team. I Bot Runners assistiti che possono visualizzare tutti i bots archiviati nello spazio di lavoro
Pubblico possono ora visualizzare i bots assegnati ai team in AARI Assistant.
Bot setup alla pagina 2178

Miglioramenti al logo del modulo
Ora puoi utilizzare il campo Logo nel piè di pagina per selezionare fino a due logo indipendenti
che vengono visualizzati nel piè di pagina del modulo durante il runtime del bot.
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Aggiunta di regole a vari elementi del modulo
Quando si crea o si modifica un modulo nel creatore di moduli, è ora possibile aggiungere regole ai
seguenti elementi del modulo utilizzando la scheda Regole del modulo:
• Checkbox
• Data
• Documento
• Elenco a discesa
• Etichetta
• Numero
• Password
• Pulsante di opzione
• Rich Text Editor
• Area testo
• Casella di testo
• Ora

Per gli elementi Checkbox e Pulsante di opzione, le regole sono attivate solo se le
corrispondenti impostazioni predefinite sono selezionate. Ad esempio, se un modulo ha due opzioni
che si escludono a vicenda, come Sì e No, le regole associate a queste opzioni vengono attivate
solo quando si seleziona una delle due opzioni.
Aggiunta di regole agli elementi di un modulo alla pagina 2202
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Aggiornamenti ai trigger
Per eseguire un bot sono ora disponibili i seguenti trigger:
• Trigger di processo: Avvia un bot quando lo stato del processo specificato in Microsoft

Windows soddisfa una delle seguenti condizioni predefinite:
• Avvia
• Sospendi

Aggiunta di un trigger di processo alla pagina 2214
• Trigger di servizio: Avvia un bot quando lo stato del servizio specificato in Microsoft Windows

soddisfa una delle seguenti condizioni predefinite:
• Avvia
• Sospendi
• Riprendi
• Metti in pausa
• In esecuzione
• È stato sospeso
• È in pausa

Aggiunta di un trigger di servizio alla pagina 2214
• Trigger di finestre: Avvia un bot quando la finestra dell'applicazione specificata soddisfa una

delle seguenti condizioni predefinite:
• Apri
• Chiudi

Aggiunta di un trigger di finestra alla pagina 2215

Discovery Bot

Novità

Installare Bot Agent senza problemi
Se Bot Agent non è ancora stato installato, verrà ora richiesto di installare Bot Agent dalla scheda
Processi. Segui le istruzioni sullo schermo per installare il Bot Agent. Dopo l'installazione, viene
richiesto di abilitare un plug-in di Chrome per procedere con le attività di registrazione.
Prerequisiti per Discovery Bot alla pagina 2335

Miglioramento delle opportunità generate automaticamente
È ora possibile iniziare a rivedere un'opportunità generata automaticamente dalla scheda
Opportunità quando almeno una registrazione di processo viene presa in considerazione per
l'esame. Esamina l'opportunità generata automaticamente e scegli di creare un'opportunità
personalizzata da un'opportunità generata automaticamente, come richiesto.
Esame delle opportunità, conversione in bot e creazione di PDD alla pagina 2355
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Nuove registrazioni da esaminare per opportunità personalizzate
È ora possibile esaminare le nuove registrazioni inviate da un utente Discovery Bot per
un'opportunità personalizzata. È possibile scegliere di accettare o rifiutare gli aggiornamenti della
registrazione come parte del flusso di lavoro dell'opportunità personalizzata. Questa opzione
permette di esaminare rapidamente e facilmente le nuove registrazioni in tempo reale, mentre
queste vengono inviate dall'utente per tale processo.
Esame delle opportunità, conversione in bot e creazione di PDD alla pagina 2355

Miglioramenti alla pagina Opportunità
La pagina delle opportunità è ora aggiornata per includere una mappa dell'evoluzione delle
opportunità, insieme ad altri grafici, per aiutare a rivedere e analizzare i dati per una potenziale
opportunità di automazione. Utilizza la mappa dell'evoluzione delle opportunità per scegliere quali
opportunità automatizzare per prime.
Analisi delle opportunità di automazione alla pagina 2354

Scarica il documento PDD dalla pagina Registrazioni
È ora possibile scaricare ed esportare un documento PDD dalla pagina Registrazioni. Dopo
l'invio di una registrazione per la revisione da parte di un analista, il PDD inizia automaticamente
l'elaborazione in background. Quando il PDD viene generato, il campo cambia da Elaborazione
PDD in corso a Scarica. È ora possibile scegliere di scaricare il documento in formato Word, PDF
o entrambi. Viene anche inviata una notifica via e-mail all'utente aziendale all'indirizzo e-mail
in archivio. Scarica PDD come documento Word o PDF è disponibile anche per un'opportunità
personalizzata dalla tabella Elenco delle opportunità.
Esame delle opportunità, conversione in bot e creazione di PDD alla pagina 2355

Limitazioni

In the Community Edition and Free Trial version, if five processes are created by the user and
then deleted, the auto-generated opportunity will fail when the recording is submitted for the sixth
process.
Soluzione: Create a new Community Edition and Free Trial user to create new processes and
opportunities.

IQ Bot

Novità

Document Automation rilasciato in Community Edition
Community Edition offre ora funzionalità limitate dalla versione di Document Automation. Questa
versione è integrata in Community Control Room. Quando si crea un'istanza di apprendimento, IQ
Bot crea automaticamente bots RPA per estrarre e scaricare i dati e un processo AARI per gestire il
processo dall'inizio alla fine. La convalida avviene ora nelle attività AARI.
Utilizza Community Edition IQ Bot per estrarre i dati dalle fatture in inglese.
Community Edition alla pagina 2467
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Miglioramenti del classificatore
È ora possibile creare gruppi di documenti personalizzati in un'istanza di apprendimento. Questo
riduce la possibilità che un OCR non riesca a rilevare i campi in un documento, il che farà sì che il
classificatore crei un gruppo di documenti inutilmente o invii il documento a un gruppo sbagliato.
Informazioni sul Classificatore alla pagina 2484

Note sulla versione Automation 360 v.22 Community Edition
Data di rilascio:15 settembre 2021

Esaminate le nuove funzioni nella Community Edition di Automation 360 v.22 (Build 10535).

RPA Workspace

Novità

Introduzione al package di file di testo
È ora disponibile un nuovo package di file di testo che include l'action Ottieni testo. Con questa
action è possibile estrarre il testo dai file che contengono caratteri giapponesi con codifica Shift-JIS
e quindi salvare il contenuto nei file in una variabile stringa.
Text file package alla pagina 1915

Condivisione di una sessione tra bots
È possibile condividere una sessione di DLL, Excel e dell'Emulatore di terminale tra più bots
utilizzando l'opzione Sessione globale. È anche possibile condividere una sessione con bots
figlio specifici utilizzando l'opzione Variabile e condividere una sessione solo con il bot corrente
utilizzando l'opzione Sessione locale.
Sharing sessions across bots alla pagina 1487

Miglioramenti al AISense Recorder
Il AISense Recorder ora consente l'automazione di applicazioni che utilizzano interfacce in russo e
una combinazione di interfacce in russo e inglese.
AISense per la registrazione di attività da applicazioni remote alla pagina 1965

Miglioramenti delle condizioni del registratore per i packages
• Utilizzare la nuova condizione L'oggetto non esiste dall'elenco delle condizioni di qualsiasi

package per verificare se un oggetto specifico esiste in una finestra e quindi eseguire delle
actions in base al risultato.
Questa condizione funziona anche con la tecnologia SAP.

• La condizione di Oggetto esistente viene ora rinominata in L'oggetto esiste.

Loop package alla pagina 1681
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Miglioramenti al package Excel advanced
• Aprire i file con le estensioni .xml e .txt usando l'action Apri.
• Utilizzare il carattere jolly (*) nell'action Apri per i nomi di file per eseguire la ricerca in base al

modello di carattere jolly.
• Quando si utilizza l'action Esegui macro e si specifica un argomento che ha un valore vuoto,

questo valore vuoto può ora essere passato alla macro.

Nuova opzione nel database: Disconnect action
In Database:action Disconnetti, è ora possibile utilizzare l'opzione Mantieni lo schema del
database nella cache fino al termine dell'esecuzione del bot per consentire all'action Ciclo
di iterare il set di dati utilizzando lo schema memorizzato nella cache dopo la disconnessione dal
database.

Use regular expressions in File > Open action  (Service Cloud case ID: 00737614)
Utilizzare le espressioni regolari (regex) nell'action Apri del package File per supportare la ricerca
basata su modelli.

Specifica del timeout per bots (ID caso Service Cloud: 00667049, 00690892, 00699158,
00706491, 00739420, 00739415, 00741590, 00769795)
È ora possibile specificare l'intervallo di tempo entro il quale deve essere completata l'esecuzione
di un bot. Il sistema interrompe l'esecuzione del bot se non viene completata entro l'intervallo di
tempo specificato.
Configurare il timeout per l'esecuzione di bot alla pagina 2017

Nuova versione di Exchange supportata nel package Email
Nel package Email, quando si sceglie un server EWS per stabilire una connessione, è ora possibile
utilizzare l'opzione Exchange2013 nel campo Versione Exchange.

Nuova actions nel package Window
• Utilizzare l'action Chiudi tutto per chiudere tutte le finestre o i programmi in esecuzione sul

sistema, ad eccezione delle finestre aggiunte nel campo Aggiungi finestra.
• Utilizzare l'action Ripristina per ripristinare le dimensioni di una finestra o di un'applicazione

ingrandita o ridotta a icona in esecuzione sul sistema.

Window package alla pagina 1929

Nuova opzione per la ricerca di testo all'interno del contenuto del bot in Bot editor (ID
caso Service Cloud: 00735685, 00736201, 00739122, 00740481, 00733885, 00748970, 00746459,
00738181,00756441,00759037,00761453,00764478)
In Bot editor, utilizzare la casella di ricerca nella visualizzazione Flusso, Elenco o Doppia per cercare
testo, variabili o actions nel contenuto dell'intero bot, come nome del pacchetto, nome dell'azione,
nome della stringa o nome della variabile. Questa funzione consente di visualizzare o modificare un
bot con lunghe righe di codice per determinare dove e in quale linea viene utilizzato il testo cercato,
ad esempio variabili, stringhe o actions.
Actions palette for bot creation alla pagina 1363

Supporto migliorato per URI di SOAP Web Service (ID caso Service Cloud: 00759811)
Nel package SOAP Web Service, se il campo Indirizzo posizione è vuoto, il bot ora recupera
l'indirizzo posizione dal file WSDL.
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Nuova opzione nel package SOAP Web Service
Utilizzare l'opzione Genera richiesta SOAP nel package SOAP Web Service per recuperare
i dettagli della richiesta SOAP dall'URI SOAP o dal file WSDL. È ora possibile selezionare
qualsiasi operazione dall'elenco di servizi e porte disponibili nella richiesta SOAP per compilare
automaticamente i dati nei campi dell'action SOAP Web Service.
Esempio di utilizzo dell'azione Servizio Web SOAP alla pagina 2076

Nome TNS supportato per la connessione al Oracle Database
Il nome TNS (Transparent Network Substrate) è ora supportato nel Oracle Database. È possibile
connettersi al Oracle Database specificando il nome TNS e il percorso del file di configurazione
tnsnames.ora.

Opzione di tempo di attesa nel package Google Sheets (ID caso Service Cloud: 00738249,
00817449, 00814775)
Nel package Google Sheets, quando si utilizza l'action Connetti per stabilire una connessione con il
server Google, è ora possibile impostare un tempo di attesa nel campo Attendi il completamento
dell'azione durante l'esecuzione di actions quali Ottieni, Imposta o Elimina. Ad esempio, se
si dispone di un file di grandi dimensioni che richiede molto tempo per l'apertura, è ora possibile
impostare il tempo di attesa per l'apertura del file prima che il sistema esegua il set successivo di
actions.

Nuova opzione per l'action Metti del package Dictionary
You can now assign a static value to a key for a dictionary variable by using the Static value
option in the Put action in the Dictionary package.
Dictionary package alla pagina 1479

Clic relativo e occorrenza supportati nei packages (ID caso Service Cloud:
0055643,00754173)
Quando si acquisisce un'immagine di destinazione tramite il package Image Recognition, è ora
possibile utilizzare l'opzione Anteprima per selezionare un'occorrenza acquisita specifica e
posizionare la posizione del clic in relazione all'immagine.
Questa funzione è supportata nei seguenti packages e actions:
• Image Recognition > Trova l'immagine nella finestra
• Image Recognition > Trova la finestra nella finestra
• If > Condizione di Riconoscimento delle immagini
• Loop > Condizione Durante > Riconoscimento delle immagini
• action Attendi la condizione > Condizione di Riconoscimento delle immagini

Using Find image in window action alla pagina 1632|Using the Find window in window action alla pagina
1635

Miglioramenti alla chiave del tipo di esecuzione nella variabile AATaskExecutor
• When you schedule a bot to run, the Execution_Type key in the AATaskExecutor variable now

returns information about the execution type with schedule type (frequency) such as Run as
 schedule Daily, Run as schedule Weekly, or Run as schedule Monthly.

• When you use a trigger in a bot, the Execution_Type key can be accessed through the
trigger data. The Execution_Type key returns the Run through Trigger as a string for
triggers.
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Supporto delle lingue per i nomi delle variabili
I nomi delle variabili ora supportano le lingue greca e giapponese. È ora possibile creare i nomi
delle variabili utilizzando i seguenti caratteri:
• Caratteri greci maiuscoli e minuscoli
• Caratteri giapponesi Katakana a larghezza intera e a mezza larghezza.

New option in REST Web Service (Service Cloud case ID: 00764198, 00800287)
In the REST Web Service package, you can now use the Allow insecure connection when
using https option to skip SSL certificate validation and to allow non-secure connections.

Filtri per l'ID dell'elemento di lavoro e l'ora per le automazioni dei carichi di lavoro
Combinare l'ID dell'elemento di lavoro e l'ora di inizio di una coda per cercare elementi di lavoro
specifici e monitorare l'avanzamento di tali elementi di lavoro. L'ora di inizio filtra l'elenco di tutti gli
elementi di lavoro che iniziano tra la data di inizio e l'ora di inizio specificate.
Actions allowed on view queue page alla pagina 2818

Miglioramenti alla struttura del bot
Abbiamo migliorato la leggibilità complessiva della struttura del bot e aggiornato le etichette dei
nodi del bot per visualizzare in dettaglio le proprietà e i parametri selezionati di ciascuna action
nelle visualizzazioni Flusso, Elenco e Doppia. Non è più necessario espandere ciascuna action per
visualizzare questi dettagli.
Le visualizzazioni Flusso, Elenco e Doppia visualizzano le seguenti proprietà delle actions:
• Il valore immesso per le actions, ad esempio Imposta testo per tutte le tecnologie supportate
• I nomi degli oggetti su cui sono eseguite le actions, ad esempio Imposta testo, Fai clic, Clic

sinistro, Ottieni proprietà e Seleziona elemento per indice
• Il nome della proprietà dell'oggetto menzionata nell'action
• Il nome della variabile restituita se un valore è assegnato a una variabile
• L'elenco delle proprietà per l'action Ottieni proprietà

Applicazioni Java supportate nel package di integrazione app
Il package di integrazione app ora supporta applicazioni Java basate su Standard Widget Toolkit
e Abstract Window Toolkit, che possono disegnare testo utilizzando API di disegno del testo di
Windows.

Supporto per il download diretto in Bot Store
Gli utenti che non possono connettere la propria Control Room a Internet possono ora scaricare
direttamente bots e packages di Automation 360 localmente da Bot Store e importarli nella propria
Control Room.
Download locally and import bots and packages from Bot Store to Control Room alla pagina 2947
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Selezionare l'input elemento file supportato per l'azione Crea una richiesta
L'azione Crea una richiesta nel pacchetto Web AARI ora supporta il passaggio di input nei
moduli di creazione della richiesta all'elemento Seleziona file. È ora possibile utilizzare bots per
creare una richiesta e caricare o scaricare file come input con l'elemento Seleziona file. Questi
file di input vengono caricati nel servizio di archiviazione per essere disponibili per un'ulteriore
elaborazione nella richiesta.

Supporto delle variabili di output nell'editor di processo
La sezione Variabili di output nell'editor di processo consente di creare una variabile definita
dall'utente che può essere impostata come output per qualsiasi processo. In questo modo è
possibile passare l'output dal processo figlio (secondario), chiamato in Attività del processo, al
processo padre (principale).
Use an Output variable alla pagina 2144

Visualizzazione dettagli nella pagina Attività
Per una migliore gestione delle attività, la nuova opzione Visualizzazione dettagli nella pagina
Attività fornisce informazioni più dettagliate sulle singole attività. La visualizzazione dei dettagli
mostra in anteprima ogni attività nella rispettiva pagina di visualizzazione delle richieste senza
aprire un'altra pagina, il che permette di organizzare e far corrispondere le attività alle richieste
disponibili. Gli utenti possono interagire anche con le proprie attività.

Discovery Bot

Novità

Visualizzazione di gruppi di fasi
Quando si esamina una visualizzazione del processo, è ora possibile utilizzare l'opzione o l'icona
del gruppo per visualizzare gruppi di fasi che appartengono all'azione di livello primario e all'azione
di livello secondario (e alle azioni a livello di sottogruppo) utilizzate durante la sessione di
registrazione.
Utilizzare l'icona del gruppo per decidere quali gruppi di fasi selezionare per un'attività che si
desidera automatizzare. Ad esempio, un'azione di livello principale visualizza Microsoft Outlook,
un'azione di livello secondario visualizza la notifica della posta di Outlook e le azioni di livello
sottogruppo visualizzano termini quali e-mail - Aggiungi a, E-mail – Aggiungi oggetto.
Create a process view with branches and opportunities
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Uso dell'opzione Dinamica per le viste generate dal sistema
You can now use the Dynamic option from the Model options to view recordings where groups of
steps display a set of repeating patterns that belong to the same application or same primary level
action used during the recording session.
Utilizzare questa opzione per decidere il contesto del processo o dell'attività che si desidera
automatizzare. I gruppi di fasi etichettati appartengono ad applicazioni supportate come Microsoft
(Excel, Outlook e Blocco note), Blocco note++, editor di testo, la maggior parte dei casi di utilizzo
delle finestre e la funzionalità del browser Chrome.
Create a process view with branches and opportunities

Miglioramenti al documento PDD Word
Il documento PDD Word ora include un diagramma di flusso della registrazione dei processi e il
tempo di ogni singola fase in ore, minuti e secondi.
Review opportunities and convert to

Previous Community Edition Release Notes
Review the release notes for previous Community Edition releases.

Note sulla versione Automation 360 v.21 Community Edition

Data di rilascio:2 giugno 2021

Esaminate le nuove funzioni nella Community Edition di Automation 360 v.21 (Build 9664).
• RPA Workspace alla pagina 681
• AARI
• Discovery Bot alla pagina 685

RPA Workspace

Importante:  This release includes a required update to your . Ensure that you complete the update to
continue with your automation activities when upgrading from a previous release to this release.
Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina
1043

To verify which  version is compatible with this release, see Compatibility with release builds alla pagina
1026.
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Miglioramenti alla navigazione di Automation 360
Abbiamo migliorato la leggibilità e l'accessibilità complessive dell'interfaccia Automation 360 .
Per semplificare la navigazione, i menu e le visualizzazioni sono organizzati in base alle funzioni
utilizzate di frequente e alle attività correlate.
L'interfaccia include i seguenti aggiornamenti:
• Le icone Dispositivo, Profilo e Guida si trovano ora nella parte inferiore del menu di navigazione

e tutti i comandi sono concentrati sulla sinistra per un facile accesso.
Facendo clic su queste icone, vengono visualizzati riquadri a comparsa di contenuti e azioni.

• Il menu di navigazione laterale può essere compresso in una barra sottile per ingrandire l'area di
lavoro principale.
È possibile continuare a utilizzare la barra di navigazione laterale in modalità compressa, con i
riquadri a comparsa per ciascuna sezione.

Automation 360 navigation updates

Distribuzione dell'automazione dei carichi di lavoro su un server di terminale Windows
multiutente
Per ottimizzare l'automazione dei carichi di lavoro e i dispositivi multiutente, è possibile distribuire
automazioni dei carichi di lavoro su un server di terminale Windows multiutente, in modo che un
singolo dispositivo possa elaborare più elementi contemporaneamente.
About multi-user devices alla pagina 2631 | About device pools alla pagina 2635

Nuove actions del package BAPI SAP
Utilizza le nuove actions seguenti:
• Esegui il flusso di lavoro standard: Esegue un flusso di lavoro standard in BAPI SAP.
• Esegui flusso di lavoro personalizzato: Esegue un flusso di lavoro personalizzato in BAPI

SAP.

BAPI SAP package alla pagina 1831

Nuova actions nel package File
Utilizza le nuove actions seguenti:
• Ottieni nome: Legge il nome di un file e lo memorizza in una stringa.
• Ottieni percorso: Recupera il percorso del file e lo memorizza in una stringa.

File package alla pagina 1562

Espressione tabella comune supportata nel package Database
È ora possibile utilizzare l'espressione tabella comune (CTE) nell'action Leggi da utilizzando la
parola chiave WITH (CON) nei database compatibili SQL come Oracle e MySQL. Utilizza le istruzioni
CTE all'interno di una query SQL per semplificare unioni e sottoquery complesse.
Using the Read from action alla pagina 1457

© 2023 Automation Anywhere. All rights reserved.     682

https://developer.automationanywhere.com/blog/automation-360-navigation-updates


    Automation Anywhere - Learn

Nuove funzionalità

Supporto per numeri grandi nel Number package (ID caso Service Cloud: 00557619)
È ora possibile eseguire operazioni matematiche su numeri grandi con maggiore precisione nel
package Number.
Number package alla pagina 1695

Supporto per database Snowflake tramite driver OBDC (ID caso Service Cloud: 00761695)
Il driver OBDC Snowflake è ora supportato nel package Database. Puoi connetterti al database
Snowflake utilizzando le applicazioni client basate su ODBC.
I seguenti actions supportano questa funzionalità:
• Connetti
• Disconnetti
• Leggi da
• Esporta in tabella dati
• Inserisci/aggiorna/elimina

Variabili: nuove funzioni e miglioramenti (ID caso Service Cloud: 00740585)
• Modifica il nome della variabile dopo la creazione della variabile.
• Elimina tutte o una selezione specifica di variabili inutilizzate da un bot.

Universal Recorder new features and enhancements
• Registra le interazioni degli oggetti in applicazioni basate sul framework Electron.
• Doppio clic in tutte le applicazioni e i browser supportati.

Limitazione dell'uso dell'attributo credenziale ai soli campi password (ID caso Service
Cloud: 00740585)
Quando si crea o si modifica un attributo credenziale, assicurati che i bots immettano il valore
dell'attributo solo nei campi identificati come campi password selezionando l'opzione Imposta
questo attributo come password.

Nomi predefiniti per le variabili di output
Quando si configura una variabile di output per le actions nei packages Error handler e Python
Script, la Control Room genera automaticamente un nome descrittivo predefinito della variabile. Se
si crea più di una variabile di output per un'action, ai nomi delle variabili successive viene aggiunto
-1, -2, -3 e così via per evitare un conflitto tra i nomi variabile.

Nuova action stringa per supportare le variabili nidificate
Utilizza l'action Stringa > Calcola valore per confrontare una variabile stringa specificata
dall'utente con le variabili stringa nel bot. Se viene trovata una corrispondenza, l'action restituisce il
valore della variabile corrispondente.
String package alla pagina 1881

Eliminazione di valori globali
A user with the AAE_Admin role can delete a global value from the All global values page.
Valori globali alla pagina 2044
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Supporto del driver ODBC per tutte le stringhe di connessione (ID caso Service Cloud:
00748887, 00777676)
È ora disponibile un driver ODBC (Open Database Connectivity) per il supporto di tutte le stringhe
di connessione ODBC nello stesso modo in cui è stato utilizzato nella versione Enterprise 11.
Utilizzando SQL come standard per l'accesso e la gestione dei dati, è possibile connettersi a MySQL,
Google BigQuery, Snowflake e ad altri database utilizzando il driver ODBC.

Condivisione di una sessione DLL
È ora possibile condividere una sessione DLL tra bots.

Automation Anywhere Robotic Interface (AARI)

Nuove funzionalità

Scaricare, eliminare o visualizzare i file nel browser in moduli o attività iniziali
Gli utenti possono ora utilizzare l'elemento Seleziona file per scaricare i file caricati in moduli o
attività iniziali e possono anche eliminare i file o accedere al file di collegamento ipertestuale per
visualizzare il file all'interno del browser. È possibile accedere al file caricato come collegamento
ipertestuale e scaricare ed eliminare nuove icone.

Miglioramento dei ruoli all'interno del team
Il team AARI prevede tre ruoli:
• Membro: L'utente può creare, modificare ed eliminare le proprie richieste. In un team privato,

tutti i compiti vengono assegnati automaticamente al membro al momento della creazione della
richiesta. In un team condiviso, il membro può assegnare attività ad altri membri.

• Proprietario: Può creare, visualizzare, eliminare e assegnare tutte le richieste dei membri del
team.

• Amministratore: Può creare, visualizzare, eliminare e assegnare tutte le richieste dei membri del
team. L'amministratore può anche modificare il team.

Un amministratore o manager AARI può modificare i propri team e aggiornare i ruoli dei membri
del team. Inoltre, può aggiungere o rimuovere i membri del team. Per impostazione predefinita, il
manager AARI è l'amministratore del team quando crea un team.

Funzione Assegna a me nelle attività
Quando l'assegnazione di un'attività viene annullata e gli utenti accedono alle attività, utilizzare
l'opzione Assegna a me per consentire l'assegnazione delle attività all'Assegna a me per
consentire l'assegnazione delle attività all'utente corrente in modo da consentire l'accesso
immediato al modulo.
Assign or unassign a task alla pagina 2167

Nuova pagina Bot
Quando i membri del team AARI con licenze Bot Runner assistiti accedono all'interfaccia Web,
vengono reindirizzati automaticamente a AARI Assistant. Gli utenti possono visualizzare tutti i bots
creati da loro in questa pagina. Possono inoltre aggiungere, cercare e ordinare i bots loro assegnati.
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Nuovo riferimento al team nelle pagine Richiesta e Processo
L'utente può ora fare riferimento al team da cui viene creata una richiesta facendo riferimento alla
nuova colonna Team nella pagina Richiesta o al nome del team aggiunto al titolo del processo
nella pagina Processo, per guidare l'assegnazione del team.

Nuovo campo Visibilità richiesta (ID caso Service Cloud: 00718119)
Visibilità richiesta permette agli utenti di consentire o limitare l'accesso da parte di altri membri del
team a una richiesta creata. Quando il campo Visibilità richiesta è impostato su Condivisa, tutte
le richieste sono accessibili a tutti i membri, i proprietari e agli amministratori del team. Se il campo
è impostato su Privata, le richieste sono disponibili solo per l'utente che ha creato la richiesta, il
proprietario e l'amministratore del team.

Miglioramenti alla pagina Processi
Nella pagina Processi sono disponibili i seguenti miglioramenti:
• Ordinamento dei processi per nome, in ordine crescente o decrescente.
• Attivazione/disattivazione del blocco di un processo.
• Utilizzo della visualizzazione dinamica per regolare la visualizzazione in base alle dimensioni dello

schermo.

AARI Assistant for attended Bot Runners
L'applicazione AARI Assistant consente agli utenti con licenza Bot Runner assistiti l'accesso ai propri
bots senza accedere alla Control Room. Gli utenti Web di AARI possono utilizzare AARI Assistant
solo quando la licenza assistita di Bot Runner è attivata insieme alla licenza utente di AARI senza
influire sulle funzionalità esistenti.
Informazioni su AARI Assistant alla pagina 2180

Aggiunta di righe dal menu contestuale della riga d'intestazione
Quando durante il runtime del bot viene avviato un modulo con una tabella, viene visualizzata solo
la riga dell'intestazione. Utilizza uno dei seguenti metodi per aggiungere nuove righe alla tabella:
• Menu contestuale riga d'intestazione della tabella

Utilizzo dell'elemento Tabella alla pagina 2200
• Azione Imposta in un bot

Imposta action alla pagina 1876

Discovery Bot

Nuove funzionalità

Ordinare un titolo processo dalla pagina Processi
È ora possibile utilizzare il campo Ordina per individuare rapidamente un titolo di processo. Dalla
pagina Processi utilizza il menu a discesa per ordinare in ordine alfabetico un titolo di processo in
base al nome del processo. In alternativa, è possibile ordinare dal processo più recente creato al
processo meno recente e viceversa.
Create a Discovery Bot process alla pagina 2344
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Miglioramenti delle opportunità
Ora puoi rivedere e analizzare immediatamente le opportunità generate automaticamente (o
generate dal sistema) dalla pagina Opportunità. Le opportunità generate automaticamente
vengono create quando almeno due registrazioni vengono approvate dall'utente. È possibile creare
un'opportunità personalizzata da un'opportunità generata automaticamente e applicare le opzioni
Modello e Filtro per individuare un'opportunità specifica per l'automazione.
È ora possibile assegnare in un processo priorità alle opportunità in base a una formula semplice
per tutte le registrazioni. Dalla tabella Opportunità, è possibile visualizzare il costo senza
automazione e risparmi per una particolare opportunità. Il sistema calcola automaticamente i costi
e i potenziali risparmi per ogni opportunità generata. Puoi personalizzare queste metriche in base al
modello della tua organizzazione per quanto riguarda costi e risparmi.
Review opportunities and convert to

I file PDD generati sono disponibili sul server locale
Il file PDD generato per un'opportunità viene ora memorizzato localmente sul server per
le distribuzioni On-Premises. I file PDD esistenti vengono automaticamente spostati nella
nuova posizione e non vengono eliminati quando viene eseguita una nuova installazione o un
aggiornamento in Control Room.
Prerequisiti per Discovery Bot alla pagina 2335

Note sulla versione Community Edition A2019.20

Data di rilascio:14 aprile 2021

Esamina le nuove funzioni della Community Edition versione A2019.20 (Build 8846).
• Community Edition
• AARI
• Discovery Bot alla pagina 690
• Bot Insight alla pagina 691

Community Edition

Importante:  This release includes a required update to your . Ensure that you complete the update to
continue with your automation activities when upgrading from a previous release to this release.
Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina
1043

To verify which  version is compatible with this release, see Compatibility with release builds alla pagina
1026.
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Automatizzate le attività relative a SAP utilizzando BAPI SAP
Utilizza le actions disponibili in BAPI SAP package per automatizzare le attività relative a SAP tramite
BAPI SAP.
BAPI SAP package alla pagina 1831

Nomi predefiniti per le variabili di output
Quando si configura una variabile di output per i seguenti packages, il Control Room mostra un
nome descrittivo della variabile predefinita. Se si creano diverse variabili di output, i nomi delle
variabili successive vengono aggiunti con -1, -2, -3 e così via per evitare la duplicazione.
• Browser
• CSV/TXT
• Email
• Excel advanced
• JavaScript
• Loop
• Recorder
• VBScript
• Window

Dividi PDF con pagine vuote supporta la scansione di documenti di immagini (Service
Cloud case ID: 00683923)
Utilizza l'action Dividi PDF per separare una pagina vuota dalle pagine con immagini acquisite.
Con la suddivisione basata su pixel, puoi ora utilizzare Dividi documento per dividere un PDF con
separatori di pagine vuote di documenti acquisiti (basati su immagini).

Intervallo di porte SMTP ampliato per includere le porte da 1 a 65535
Il package Email supporta ora porte comprese tra 1 e 65535 per il server SMTP. Ora puoi utilizzare
l'action Invia configurando la porta SMTP in questo intervallo.

Nuove actions in package Active Directory
• Aggiorna opzioni account: consente di impostare gli attributi di account per l'utente.
• Modifica password utente: utilizza questa opzione per modificare la password di un utente.

User account operations alla pagina 1386

Miglioramento dell'action Crea utente nel package Active Directory
È ora possibile utilizzare l'action Crea utente per creare un utente Active Directory con password.
Using the Create user action alla pagina 1388

Supporto esteso e nuove funzionalità per Universal Recorder
Utilizza Universal Recorder per eseguire le seguenti operazioni:
• Automatizzare i clic e il recupero dei dati negli elenchi a discesa e nelle caselle combinate delle

applicazioni Oracle EBS come Compass.
• Collegare un oggetto che il bot non è in grado di identificare in modo affidabile a un oggetto

vicino (ad esempio un collegamento o un pulsante) più facile per il bot da trovare. Utilizzare
questa funzione nelle applicazioni MSAA, UI Automation o Java.
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Supporto di nuove lingue con nomi variabili
Ora è possibile utilizzare caratteri cechi, danesi, olandesi, finlandesi, francesi, tedeschi, ungheresi,
italiani, norvegesi, polacchi, portoghesi, rumeni, spagnoli e svedesi nei nomi delle variabili.
Unicode range supported in variables alla pagina 2036

Cercare e aggiungere il bot figlio al bot padre
Cercare un bot figlio in spazi di lavoro pubblici e privati in modo da poterlo aggiungere al bot padre.
È possibile cercare il bot figlio con Bot editor e l'action Esegui del package Task Bot.
Using the Run action alla pagina 1896 | Bot editor for creating bots alla pagina 1358

Ottenere informazioni sull'utente che ha distribuito il bot
Use the AATaskInvoker system variable to return the username, first name, last name, and email of
the user that ran or scheduled the bot. Se il bot viene distribuito su un Bot Runner assistito, questa
variabile restituisce informazioni sull'utente connesso. Se il bot viene distribuito da un trigger,
questa variabile restituisce informazioni sull'utente associato a tale licenza .
System settings and parameters alla pagina 2025

Nuova condizione in Se package (ID caso Service Cloud: 00536088, 00690073, 00717514,
00737243, 00702383)
Utilizza la nuova condizione La finestra con lo stesso titolo non esiste o Esiste una finestra
con lo stesso titolo disponibile nel package Se per verificare se esiste una finestra con lo stesso
titolo o se il titolo della finestra è cambiato.
If package alla pagina 1625

Google packages sono ora disponibili
I packages Google Calendar, Google Drive e Google Sheets sono ora generalmente disponibili in
Automation 360, e contengono queste nuove actions:
• actions Scrivi da tabella dati e inserisci riga/colonna nel package Google Sheets.
• Ogni package Google contiene un'action Connetti per autenticare il tuo account prima di

aggiungerne altre actions dal package in questione all'automazione. Questa action sostituisce la
ormai obsoleta OAuth action del package G-App.

• Ogni package Google contiene un'action Disconnetti per terminare la connessione.

Utilizzo dell'azione Connetti per i pacchetti Google alla pagina 1600

Automation Anywhere Robotic Interface (AARI)

Novità

Ottenere file di archiviazione
La nuova azione Acquisisci file di archiviazione nel pacchetto Web AARI  consente di scaricare
i file di archiviazione su un dispositivo bot.
AARI Web package alla pagina 1369
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Novità

Caricare i file nei moduli o nelle attività iniziali
Aggiungi l'elemento Seleziona file ai moduli per consentire agli utenti di selezionare e caricare i
file nei moduli o nelle attività iniziali nell'interfaccia Web. Gli utenti possono navigare per caricare
un nuovo file o sostituire un file esistente. Il file caricato viene visualizzato come collegamento
ipertestuale e, quando viene aperto, reindirizza gli utenti a una nuova scheda.
Configura i processi alla pagina 2121

I collegamenti ipertestuali supportano i moduli o le attività iniziali
Usa il nuovo elemento di Collegamento ipertestuale per aggiungere collegamenti ai moduli e
accedervi nei moduli e nelle attività iniziali.
Configura i processi alla pagina 2121

Configurare un utente Pianificatore per ciascun processo (ID caso Service Cloud:
00713786)
In qualità di amministratore AARI, puoi ora configurare un utente pianificatore per ciascun processo
per allocare le risorse Control Room (dispositivi e Bot Runners non assistiti) sull'interfaccia Web. Per
impostazione predefinita, è selezionato l'utente Pianificatore globale se per i singoli processi non
è configurato alcun utente pianificatore.
Configure scheduler user for AARI on the web alla pagina 2118

Aggiornamento del pannello delle proprietà per l'attività umana (ID caso Service Cloud:
00718109)
Come Bot Creator, puoi scegliere di non configurare alcuna azione nell'attività umana selezionando
la casella di controllo Rendi il modulo di sola lettura nel pannello Proprietà. L'attività umana
non richiede alcun input e viene eseguita automaticamente nell'attività successiva.

Aggiungere un segnalibro a qualsiasi pagina come pagina di destinazione per AARI sul
Web
L'interfaccia Web è stata migliorata con un nuovo sistema a più pagine, in modo da poter
aggiungere direttamente dei segnalibri a qualsiasi pagina (Richieste, Attività o Cestino) come
pagina di destinazione. Inoltre, le schede nell'interfaccia Web sono state rimosse in modo che le
richieste vengano aperte una alla volta e non simultaneamente. Per eseguire più attività, è possibile
aprire le pagine delle richieste in diverse schede del browser.

Miglioramento della navigazione in AARI sul Web
L'interfaccia Web è stata migliorata con un riquadro di navigazione laterale, in modo da poter
accedere facilmente a varie pagine (Processi, Richieste, Cestino e Attività).

Nuova pagina Processi (ID caso Service Cloud: 00694786)
Come utente AARI, accedi ai processi assegnati e crea nuove richieste utilizzando la nuova pagina
Processi nell'interfaccia Web. Utilizza la barra di navigazione per accedere rapidamente alla pagina.
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Novità

Miglioramento dell'elemento Pulsante
• Puoi ora utilizzare l'opzione Non consentire il clic sul pulsante quando questo modulo

viene caricato per la prima volta per disabilitare l'elemento Pulsante in un modulo quando
questo viene visualizzato per la prima volta durante il runtime del bot.

• Utilizza l'opzione Sottotitolo nel menu a discesa Tipo di pulsante se si desidera che
l'elemento pulsante venga visualizzato come collegamento durante il runtime del bot.

Utilizzo dell'elemento Pulsante alla pagina 2190

Miglioramenti al logo del modulo
È ora possibile utilizzare l'opzione campo Logo nel piè di pagina per selezionare fino a due logo
indipendenti che vengono visualizzati nel piè di pagina del modulo durante il runtime del bot.
Create a form alla pagina 2186

Discovery Bot

Novità

Cercare un processo aziendale dalla pagina Processi
È ora possibile utilizzare il campo di ricerca per individuare un processo specifico per nome. Questo
campo non è sensibile alla distinzione tra maiuscole/minuscole. Il campo di ricerca è disponibile
nella pagina Processi.
Create a Discovery Bot process alla pagina 2344

Visualizzare tutte le immagini acquisite dalla finestra modale dello screenshot
È ora possibile navigare tra tutte le schermate acquisite facendo clic su un'immagine a dimensione
completa dalla finestra modale. Fai clic sull'impaginazione situata sotto l'immagine per selezionare
un numero di fase o utilizza le frecce destra o sinistra per visualizzare rapidamente tutte le immagini
acquisite.
Registrare un processo aziendale Discovery Bot alla pagina 2348

Il pacchetto Process Discovery è incluso nei pacchetti predefiniti
Il pacchetto Process Discovery è ora incluso nei pacchetti predefiniti. È possibile precaricare il
pacchetto predefinito quando si effettua la connessione al dispositivo. Precaricare il pacchetto aiuta
a ridurre l'ora di avvio del registratore la prima volta che si inizia la registrazione di un processo
Prerequisiti per Discovery Bot alla pagina 2335
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Novità

Miglioramenti del registratore
Puoi ora eseguire azioni come fare doppio clic, trascinare e rilasciare e selezionare il testo
durante la registrazione di un processo aziendale. Le azioni eseguite con i tasti di scelta rapida
vengono visualizzate nel campo Dati. Il doppio clic viene acquisito dal registratore e visualizzato
nell'immagine della pagina Registrazioni.

Nota:  Il registratore Discovery Bot non acquisisce le azioni di trascinamento e mantenimento del
clic dalla pagina Registrazioni. Per includere queste azioni eseguite durante la registrazione, puoi
documentare le singole fasi nel campo Descrizione fase per l'analista.

Registrare un processo aziendale Discovery Bot alla pagina 2348

IQ Bot

Limitazioni note

Gli indirizzi IPv6 non sono supportati per IQ Bot, quindi assicurati di utilizzare solo gli indirizzi IPv4.

Bot Insight

Novità

Accesso con ruolo AAE_Admin all'API delle operazioni da connettore Power BI
Il connettore Power BI fornisce ora l'accesso con ruolo utente AAE_Admin all'API operativa
botrundata. Con questo ruolo, è possibile connettersi all'API botrundata ed estrarre metriche
operative da analizzare e visualizzare all'interno di Power BI.

Miglioramenti al dashboard di pubblicazione (produzione)
Gli utenti con ruolo Amministratore AAE_Bot Insight e Esperto AAE_Bot Insight possono
ora modificare il dashboard pubblicato. Puoi utilizzare l'opzione Salva per salvare il dashboard di
produzione come dashboard di produzione personalizzato e aggiungere widget al tuo dashboard
personalizzato. Puoi inoltre eliminare un dashboard di produzione predefinito e un dashboard di
produzione personalizzato.
Salvare un dashboard pubblicato alla pagina 2971 | Eliminare un dashboard pubblicato alla pagina 2972

Importante:  Le informazioni sui pacchetti supportati vengono spostate in questo argomento: View
package versions available in the Control Room alla pagina 2009.

Note sulla versione Community Edition A2019.19

Data di rilascio: 05 February 2021

Esamina le nuove funzioni della Community Edition versione A2019.19 (Build 8145).
• Community Edition alla pagina 692
• AARI
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• Discovery Bot alla pagina 694

Community Edition

Importante:  This release includes a required update to your . Ensure that you complete the update to
continue with your automation activities when upgrading from a previous release to this release.
Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina
1043

To verify which  version is compatible with this release, see Compatibility with release builds alla pagina
1026.

Nuove funzionalità

Nuove funzionalità nel Data Table package (ID caso Service Cloud: 00656843, 00707635)
• Utilizza l'action Modifica tipo di colonna nel package Data Table per eseguire operazioni sulla

colonna di una tabella di dati. Utilizza questa action per modificare il tipo di dati della colonna in
Booleano, Data e ora, Numero o Stringa.

• Ordina i dati nella tabella dati in formato Numero, Data e ora, Booleano o Stringa.

Data Table package alla pagina 1439

Nuova action nel package App Integration
Utilizza l'Acquisisci testo scorrevole action per estrarre il testo dalla finestra selezionata o da un
comando qualsiasi all'interno della finestra selezionata e salvarlo in una variabile. Se fai clic su un
controllo qualsiasi all'interno della finestra, viene estratto del testo da quel controllo specifico. Se fai
clic al di fuori della finestra, viene estratto tutto il testo da tale finestra.
App Integration package alla pagina 1398

Nuova opzione casella combinata di codifica in Terminal Emulator per la serie VT
Per inviare e ricevere testo in giapponese, puoi ora utilizzare le caselle combinate Codifica e
Pagina codice, nel momento in cui effettui il collegamento all'Emulatore terminale per il tipo di
terminale serie VT.
Using Connect action for Terminal Emulator alla pagina 1903

New actions in Active Directory package
Utilizza quanto segue actions in Active Directory per automatizzare un'attività:
• Sposta un computer

Using the Move computer action alla pagina 1380
• Sposta un’unità organizzativa

Using the Move organizational unit action alla pagina 1385
• Aggiungi utenti a un gruppo

Using the Add users to group action alla pagina 1388
• Rimuovi utenti da un gruppo

Using the Remove users from group action alla pagina 1390
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Nuove funzionalità

Nuova variabile di sistema per nuovo carattere di riga (ID caso Service Cloud: 00669232,
00672775, 00673578)
Utilizza la variabile di sistema $String:Newline$ per aggiungere un nuovo carattere di riga. Questa
variabile aggiunge un nuovo carattere di riga in varie applicazioni indipendentemente dal sistema
operativo del dispositivo.

Formato zero per Enterprise A2019 (ID caso Service Cloud: 00677611)
L'action Esegui utilizza il formato zero con il nome AAZeroSizeForm che può essere impiegato
dalle DLL per identificare i formati zero creati da Enterprise A2019.

Miglioramento per definire il percorso padre inActive Directory
Quando stabilisci una connessione con un server LDAP, puoi ora selezionare il percorso LDAP
connettendoti al server.
Using Connect action for Active Directory alla pagina 1383

Ottieni informazioni sull'utente Esegui-come dopo la distribuzione del bot
Use the AATaskExecutor system variable to return the username, first name, last name, and email
of the user that ran the bot. Se bot viene distribuito su un Bot Runner custodito, questa variabile
restituisce informazioni sull'utente connesso. Se bot viene distribuito da un trigger, questa variabile
restituisce informazioni sull'utente associato a tale licenza Bot Runner.
System settings and parameters alla pagina 2025

Miglioramenti al Recorder
• Universal Recorder ora supporta l'acquisizione di oggetti in Mozilla Firefox.

Devi installare l'estensione A2019 dai componenti aggiuntivi del browser Mozilla Firefox.
• Consente di acquisire oggetti di tabelle, griglie e finestre principali dalle applicazioni SAP.

Universal Recorder supported applications and browsers alla pagina 1958 | Actions performed on objects
captured with Universal Recorder alla pagina 1755

Automation Anywhere Robotic Interface (AARI)

Nuove funzionalità

Nuova attività di filtro nell'editor di processo
Nell'editor di processo, Attività di filtro consente agli utenti di filtrare variabili come l'output
umano o l'output di un'attività bot con un criterio di filtro specifico.
Crea un processo AARI alla pagina 2133

Nuova attività di processo nell'editor di processo
Utilizza la nuova opzione Attività di processo nell'editor di processo per richiamare un
sottoprocesso all'interno del processo principale. Questa procedura aiuta a separare le attività in
processi diversi, invece di includere tutte queste attività in un unico processo. Più team possono
ora lavorare contemporaneamente su diverse attività all'interno del processo principale e rimanere
separati, senza conflitti.
Crea un processo AARI alla pagina 2133
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Nuove funzionalità

Nascondi un'attività o visualizza un'attività nascosta
Con una licenza Bot Creator, puoi ora eseguire le seguenti operazioni:
• Nascondi la visualizzazione di attività umane e bot selezionando l'opzione Nascondi questa

attività dopo il completamento nell'editor di processo.
• Visualizza un'attività umana o bot nascosta selezionando l'opzione Visualizza attività

nascoste nella pagina di visualizzazione delle attività.

Crea un processo AARI alla pagina 2133

Modifica titolo nell'editor di processo
Gli utenti possono ora modificare il titolo nell'editor di processo.

Aggiornamenti dell'editor di testo RTF (interfaccia Web)
Nell'interfaccia Web, è possibile utilizzare funzioni di editor di testo avanzato come testo in
grassetto, corsivo, sottolineato, allineamento, formattazione, colore e dimensioni nelle attività.

Aggiornamenti degli elementi della tabella (interfaccia Web)
Nell'interfaccia Web, l'elemento Tabella supporta ora l'uso di data, numero, elenco a discesa e
valori di testo nelle attività.

Aggiornamenti degli elementi nel generatore di moduli
Il generatore di moduli ora include i seguenti nuovi elementi:
• Elemento Seleziona cartella: Aggiungi un'opzione di cartella di caricamento nel modulo.

Using the Select Folder element alla pagina 2194
• Elemento Collegamento ipertestuale: Assegna un URL nel modulo.

Using the Hyperlink element alla pagina 2195

Miglioramento del trigger di azione Casella di controllo
Se un modulo con un elemento Casella di controllo viene utilizzato all'interno di un loop di
attivazione package, puoi ora utilizzare le actions di attivazione Valore selezionato e Valore non
selezionato .
Trigger loop package alla pagina 1917

Discovery Bot

Nuove funzionalità

Visualizza la durata di ogni fase registrata
Viene ora visualizzata una fase registrata in minuti e secondi per l'utente e l'analista aziendale.
Utilizza queste informazioni per comprendere quali sono i passaggi che costituiscono un collo di
bottiglia nel processo corrente e che garantiranno il massimo beneficio dall'automazione. La durata
della fase viene visualizzata dalla pagina Registrazioni (sotto l'immagine dello screenshot) e dalle
pagine Visualizza processo e Visualizza opportunità nella finestra del riquadro Anteprima.
Registrare un processo aziendale Discovery Bot alla pagina 2348
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Nuove funzionalità

Importante:  Le informazioni sui pacchetti supportati vengono spostate in questo argomento: View
package versions available in the Control Room alla pagina 2009.

Note sulla versione Community Edition A2019.18

Data di rilascio: 05 January 2021

Review the new features and supported packages in the Community Edition A2019.18 release (Build 7560).
• Community Edition A2019 alla pagina 695
• AARI
• Discovery Bot alla pagina 698
• Bot Insight alla pagina 699
• Supported packages

Community Edition A2019

Importante:  This release includes a required update to your . Ensure that you complete the update to
continue with your automation activities when upgrading from a previous release to this release.
Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina
1043

Build 7560 (Community Edition) is compatible with Bot Agent 16.19.8232.

Nuove funzionalità

Configure timeout in Bot Migration package
When migrating bots, you can now set a timeout value in the range of 3 through 90 minutes
(default value is 90 minutes). If the migration of any specific bot is not completed within the set
time, a timeout message is displayed and the migration process moves to the next bot.

Use regular expressions in variables (Service Cloud case ID: 00628227)
Use regular expressions (regex) in value type variables to specify the entity on which you want to
perform an operation. For example, actions in the File, Folder, String, and Window packages allow
use of regular expression in variables.
When Enterprise 11 or Enterprise 10 bots with commands that use regular expressions in variables
are migrated, if their equivalent actions in Enterprise A2019 do not support regular expressions, the
regular expression is converted to string in the migrated bots.
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Nuove funzionalità

Recorder enhancements
• Use the AISense Recorder Define option to record an interaction, such as click active text, with

an object that is only visible when you hover the mouse over the object.
• If you record a click and keystrokes in a text box with a Control Type of PASSWORD_TEXT,

the Recorder does not capture the keystrokes entered into the field. Instead, the action selects
the Set text option and offers users the option to select a credential from the Credential Vault,
enter a credential variable, or enter an insecure string.

Efficiently map input and output variables between parent and child bots (Service Cloud
case ID: 00537090, 00698697)
For input variables, use the Quick map option to select the variables and set the values for
the parent bot to pass. For output variables, use the Multiple variables tab to associate each
dictionary key with a variable. This feature eliminates the need to use actions to extract the output
dictionary values.
Task Bot package alla pagina 1895 | Using the Run action alla pagina 1896

Support for PowerBuilder application in App Integration package (Service Cloud case ID:
00680703)
The App Integration package now supports PowerBuilder to capture and extract text from a window
application. The Capture text of window action enables you to open a PowerBuilder screen to
capture all the data and verify the captured text.

Nuova action nel package Terminal Emulator
Use the Search Field action in the Terminal Emulator package to search for a field based on the
text it contains. This action returns the name or index of the field based on the option selected.
Terminal Emulator package alla pagina 1902

Nuova action nel package PDF
Use the Get Property action in the PDF package to retrieve the properties of a PDF file and
assigns the properties to a dictionary variable.
Using the Get property action alla pagina 1738

Nuova actions nel package Browser
Use the following actions in the Browser package:
• Close: Closes a Google Chrome browser window or tab.
• Get source code: Recupera il codice sorgente di una pagina web e lo salva in una variabile di

stringa.
• Go back: Consente di tornare a una pagina web visitata in precedenza nella scheda corrente.
• Open: Opens the browser to a specific web page in an existing tab, new tab, or window.
• Run JavaScript: Executes JavaScript in a web page.

Browser package alla pagina 1425
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Nuove funzionalità

Specify application window dimensions
Use the Resize windows option to set the window height and width to specific dimensions or
to the dimensions at which it was captured. This feature enhances the bot's ability to identify the
target object.
I seguenti packages supportano questa funzionalità:
• App Integration
• If Image recognition condition
• If Legacy Automation > Window Control condition
• Image Recognition
• Simulate keystrokes
• Legacy Automation Desktop > Manage windows controls action
• Loop While > Image recognition condition
• Loop While > Legacy Automation > Window Control condition
• Mouse
• OCR
• Screen

Support for function keys in Terminal Emulator package
Function keys (F1 through F24) are now supported to automate processes using ANSI and VT100
terminals in the Terminal Emulator package.

Use regex case insensitive flag for Window title
Enable the regex Case insensitive flag to identify a Window title field as not case-sensitive. This
feature enables you to successfully run the bots even if the letter case does not match the captured
window title.
The following packages and actions support this feature:
• Wait
• Image Recognition
• Simulate keystrokes
• Mouse > Click action
• Legacy Automation Desktop > Manage windows controls
• OCR > Capture window, Capture area
• Screen > Capture window, Capture area
• Recorder > Capture
• Window: Activate, Close, Maximize, Minimize, Resize

Automation Anywhere Robotic Interface (AARI)

Nuove funzionalità

New AARI on the web package
Use the AARI on the web package to perform actions such as assign, query, and cancel tasks;
create and query requests; and retrieve a list of team members.
AARI Web package alla pagina 1369
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Nuove funzionalità

Filter by time
You can now filter your requests and tasks by time:
• Requests tab: Use the Created and Updated options in the Filter window to select any

dates.
• Tasks tab: Use the Task created and Task updated options in the Filter window to select

any dates.

Filter and search for a request alla pagina 2168 | Filtrare e cercare un'attività alla pagina 2170

View updated dates
• Use the new Updated column in the Requests tab to view the dates and time of a request

that was last updated.
• Use the new Task Updated column in the Tasks tab to view the date and time of a task that

was last updated.

Variable options
In the Insert a variable window, the Variable field now shows child elements of available
references, which include Dictionary, List, Record, and Table variable types.

Delete a request
AARI administrators, managers, and users can now delete requests created by the AARI process.
The AARI administrator can delete any requests. AARI managers can delete requests of the team
for which they are the owner. AARI users can delete only the requests they have created.
Delete a request alla pagina 2164

Automatically assign managers and users
Users can now select the Auto assign this task option in the Human Task to assign managers
or users to the task. Users can also select the Auto assign the target task to option in the Go
to element to assign managers to the task.
Crea un processo AARI alla pagina 2133

Discovery Bot

Nuove funzionalità

Access Discovery Bot capabilities in Community Edition
Discovery Bot is now available in the Community Edition and the free trial version. Log in to the
Control Room and click the Discovery Bot tab on the left panel to get started.
The available limits to create processes, recordings, views, and opportunities are displayed on the
respective page. Create any number of bots and download a PDD for your personal use as required.
A single Community Edition user is a multi-role user with Admin plus Business user plus Analyst
permissions.
Introduzione a Discovery Bot alla pagina 2330
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Nuove funzionalità

Use Model option for system-generated views
You can now use the Model option to compare and find the best aggregated view for your
recordings. Use this option to save as many views with different combinations as required.
You can also save the view as a manual view to further customize your view and compare side-by-
side. Select either an Easy or Strict model so that you can view recordings where the steps are
the same versus recordings with different results with more branches in the process path.
Create a process view with branches and opportunities

Use Filter option for system-generated views
You can now use the Filter option to use a set of values to compare different sections of a process
across various recordings by selecting a specific path and step filter. Used along with the Model
option, the path and step filter options for a system-generated or manual view can help you to
determine and decide on a good candidate for automation.
Create a process view with branches and opportunities

Use toggle frequency counter option for system-generated views
You can now use the toggle frequency counter to display the number of recordings that a particular
path takes in the flow in a system-generated view. Use this option to help you understand the
frequency of the path compared to other recordings or views.
Create a process view with branches and opportunities

Remove recording screenshot for data privacy
Use the Screen option (icon) to display or hide the recording screenshot before submitting the
recording for the analyst to review. Use this option when you do not want to share personal image
details with the analyst.
Registrare un processo aziendale Discovery Bot alla pagina 2348

Download PDD from the Opportunities table
You can now download a process definition document (PDD) for an opportunity directly from the
Opportunities table listed on the Opportunities page. The PDD is automatically generated when
the opportunity is created. After the PDD is generated, the field changes from generating PDD to
Download PDD. You can then download and save the document.
Review opportunities and convert to

Bot Insight

Nuove funzionalità

Access Bot Insight data from Tableau
Use the Tableau connector in Bot Insight to access business and operational information. The
Tableau connector connects to the Bot Insight APIs to create various business and operational
metrics that you can analyze and visualize within Tableau.
Configure Tableau web data connector in Bot Insight alla pagina 2983
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Pacchetti supportati

Pacchetto Versione

Application 2.1.0-20201112-22332

App Integration 2.3.0-20201210-171315

Active Directory 2.1.0-20201112-223323

Boolean 2.1.0-20201126-165109

Browser 2.3.0-20201211-222811

Clipboard 2.1.0-20201126-165124

Comment 2.3.0-20201126-165125

CSV/TXT 2.3.0-20201126-165126

Database 2.2.0-20201112-223343

Data Table 2.5.0-20201201-130615

Datetime 2.2.0-20201126-165136

Delay 2.2.0-20201126-165137

Dictionary 3.2.0-20201126-165138

Run DLL 3.3.0-20201126-165850

Email 3.2.0-20201120-062604

Error handler 2.3.0-20201126-165148

Excel basic 2.4.0-20201126-165604

Excel advanced 5.3.0-20201208-090251

File 3.2.0-20201126-165151

Folder 3.1.0-20201126-165154

FTP / SFTP 2.2.0-20201115-072759

Image Recognition 2.2.0-20201117-081754

JavaScript 2.4.0-20201126-165412

Simulate keystrokes 2.5.0-20201112-223902

Legacy Automation 3.2.0-20201124-064544
1.5.0-20201125-004358

List 2.2.0-20201126-165427

Log To File 2.2.0-20201126-165428

Loop 2.1.0-20201126-165429

Message Box 2.1.0-20201126-165430

Mouse 2.2.0-20201112-223917

Number 2.1.0-20201126-165444
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Pacchetto Versione

OCR 2.3.0-20201126-081210

Office 365 Excel 2.2.0-20201104-062559

Office 365 Calendar 2.1.0-20201111-162101

Office 365 OneDrive 2.2.0-20201126-165550

PDF 2.6.0-20201126-165555

PGP 2.2.0-20201126-165557

Ping 2.1.0-20201126-165559

Play Sound 2.1.0-20201127-115706

Prompt 2.2.0-20201109-192507

Python Script 2.4.0-20201208-064944

Recorder 2,10-20201215-211402

REST Web Service 3.2.0-20201112-224735

SAP 2.2.0-20201126-165852

Screen 2.2.0-20201126-165855

SNMP 2.1.0-20201126-165859

SOAP Web Service 3.2.0-20201123-093411

String 3.1.0-20201126-165909

System 3.0.0-20200921-090225

Terminal Emulator 3.6.0-20201213-084139

VBScript 2.4.0-20201208-065526

Wait 3.1.0-20201126-165922

Window 2.3.0-20201123-093430

Workload 2.1.0-20200825-071644

XML 2.1.0-20201126-165927

Note sulla versione Community Edition A2019.17

Data di rilascio: 13 November 2020

Review the new features and supported packages in the Community Edition A2019.17 (Build 7103) release.
IQ Bot è nella Build 7082.
• Community Edition A2019 alla pagina 702
• AARI
• IQ Bot alla pagina 705
• Bot Insight alla pagina 705
• Supported packages
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Community Edition A2019

Importante:  This release includes a required update to your . Ensure that you complete the update to
continue with your automation activities when upgrading from a previous release to this release.
Aggiornamento automatico di Bot Agent alla pagina 1042 | Aggiornamento manuale del Bot Agent alla pagina
1043

Nuove funzionalità

Connect to EWS server with OAuth authentication
A new authentication is available for the Exchange Web Services (EWS) protocol with OAuth.
You can use the OAuth authentication and enable your EWS-managed API applications to access
Exchange online in Office 365.
Using Connect action for Email alla pagina 1497

VT220 terminal type supported in Terminal Emulator
To establish a connection and communicate with another machine, you can now use the VT220
terminal for sending and receiving text.
Using Connect action for Terminal Emulator alla pagina 1903

Miglioramenti al Recorder
• Record a task using the Universal Recorder or AISense Recorder from a single point of entry.

Both recorders are now managed through a single package, which enables faster and more
efficient updates.

• You can now record tasks in a Microsoft Edge browser that runs on Chromium (versions 79 and
later).

• Use the AISense Recorder Define option to capture an object that is only visible when you
hover the mouse over the object.

• Use the Resize window option in the Recorder > Capture action to set the window width
and height.
This option delivers a more reliable bot. It resizes the window to the dimensions at which the
task was recorded, thus increasing the likelihood that the bot identifies the target object.

Get started with recorders alla pagina 1948 | Universal Recorder supported applications and browsers alla
pagina 1958 | Utilizzo dell'action Acquisisci alla pagina 1763

Use shared session in Terminal Emulator
Use the new Shared session option to pass the exact state of an application to a concurrently
occurring TaskBot or MetaBot logic. For example, instead of connecting to the same application
multiple times for different tasks, you can use the option to connect to the application using a
single task, thus optimizing your automation logic in the long run.
Share session between TaskBot logic alla pagina 1914

Share an Excel session between bots
Use the Set session action from the Excel basic or Excel advanced package to assign an Excel
session to a variable, and then pass that variable from a parent to a child bot. This enables the
child bot to access the worksheet opened in the parent bot.
Excel basic package alla pagina 1527 | Excel advanced workbook operations | Example of sharing an
Excel session between bots alla pagina 1899
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Nuove funzionalità

New option for Run Task
In the Task Bot package, you can now use the Run action with an option to repeat the selected
task until you choose to stop it.

New search for roles in User Management API
Use the new Search for roles API in the User Management APIs in Swagger to obtain a list of
all the roles or details for a specific role.

Capture response status of REST API
In the REST Web Service package, you can capture the response status of the REST API in the
dictionary variable. The dictionary variable now shows the response key with its value.

New option for REST Web Service (Service Cloud case ID: 00489741, 00646436)
Use the Capture failure response action in the REST Web Service package to capture response
details in the response body.

Use regular expressions in packages
You can use regular expressions (regex) in certain actions to support pattern-based search in a file,
folder, or Windows title. Regular expressions are supported in the actions of the File and File and
Folder packages such as Copy, Delete, Rename, Print Multiple files, and Zip.
You can also use regular expressions in some packages that support the wildcard character in their
window titles.
The following packages and actions support regular expressions:
• Wait
• Image Recognition
• Simulate keystrokes
• Mouse > Click action
• Legacy Automation > Manage windows control
• OCR
• Screen
• Recorder > Capture
• Run DLL > Run function (Legacy), Run function
• Window: Activate, Close, Maximize, Minimize, Resize

Using Copy Desktop file action for file alla pagina 1563 | Utilizzo dell'action Acquisisci alla pagina 1763

Support for overloaded functions in DLL package
The DLL > Run function action can now handle .dll files that contain multiple functions of the
same name. The action calls the function based on the number of parameters passed.
Utilizzo dell'action Esegui funzione alla pagina 1488

New actions for SAP captured objects
Use new actions that are available for Tree, Tab, and Label controls to perform operations for the
various objects captured from an SAP application.
Recorder actions supported in various SAP versions alla pagina 1772
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Nuove funzionalità

Store multiple lines of text in a string variable
You can use a string variable containing multiple lines of text in the following actions:
• String > Assign
• String > Extract text
• String > Compare
• String > Lowercase
• String > Replace
• String > Reverse
• Log to file
• Message box
• The string condition in the If, Wait, and While actions

Arabic, Japanese, and Russian characters supported in variable names
You can now create variables with names containing Arabic or Russian characters, or Japanese
double-byte numbers.
Unicode range supported in variables alla pagina 2036

Automation Anywhere Robotic Interface (AARI)

Nuove funzionalità

View previous selected tasks
AARI users can now reference selected actions of their tasks. When they view a submitted task in
request view, a check mark indicator is now displayed next to the buttons that are selected.

Run a process in private workspace
You can now run a process in your private workspace by using the Run option in the process editor.
The bots in the process are then executed on the default device of the Bot Creator.
Configura i processi alla pagina 2121

Use variables types
You can now use new variables in the process editor such as createdOn and updatedOn
(DateTime), id (Number), and title (String). These variables are part of a data flow (workflow
engine) that moves data between each step of a process and requires variable input for the process
to run properly.
AARI variable types alla pagina 2141

Use the Data Privacy tag field
The Data Privacy tag enables users to generate hidden custom output in their process tasks
(Start panel, Human Task, and Bot Task). Users can enter the variables for this field during
runtime with values. In the web portal, the AARI admin can use this tag to check for requests or
tasks by using personal user data. The admin can also filter using this field.
Crea un processo AARI alla pagina 2133 | Filter and search for a request alla pagina 2168 | Filtrare e
cercare un'attività alla pagina 2170
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IQ Bot

Nuove funzionalità

Support for Arabic language
When creating a learning instance, you can now choose the Arabic language from the Primary
language of documents drop-down menu, with the following limitations:
• Advance table extraction is not available.
• Search field on the Validator is not supported.
• Arabic numerals are not supported.

For example, if the document has date or time in Arabic language, it is extracted as text and
validations can fail.

Nota:  You can still use string-based validation checks (such as regular expressions) for Arabic
numerals.

• Arabic is only supported on ABBYY FineReader Engine 12.4.

Creating a learning instance

Default validations for a group
When editing a learning instance, you can now use the Select the default validations group
drop-down menu to select an available group. This allows all the new group documents in
production to be extracted based on the custom logic and validations defined in this selected group,
before it goes to the Validator.
Edit a learning instance

Problemi risolti

ID caso Service Cloud Descrizione

- You can now create and edit a bot even if a document
associated with a deleted bot appears in production.
Previously, if a bot was deleted and a document
associated with it appeared in production, you could
not create a new bot.

Bot Insight

Nuove funzionalità

New AARI dashboard in Bot Insight
Use the AARI dashboard to view various widgets that provide information about requests created
from published processes in AARI. The dashboard also provides statistics on the status of created
requests.
AARI dashboard alla pagina 2965
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Pacchetti supportati

Pacchetto Versione

Application 2.1.0-20200921-085720

App Integration 1.1.0-20201014-042506

Analizza 2.2.4-20200903-113949

Active Directory 2.1.0-20200921-085716

Boolean 2.1.0-20201014-042509

Migrazione bot 2.5.0-20200902-045043

Browser 2.1.0-20201002-123733

Clipboard 2.1.0-20201014-042520

Comment 2.2.0-20201014-042520

CSV/TXT 2.3.0-20201014-082525

Database 2.2.0-20201013-052941

Data Table 2.3.0-20201030-143334

Datetime 2.2.0-20201014-042531

Delay 2.2.0-20201014-042532

Dictionary 3.2.0-20201014-042532

Run DLL 3.2.0-20201105-205159

Email 3.1.0-20201104-062204

Error handler 2.2.0-20201014-042541

Excel basic 2.3.0-20201027-160012

Excel advanced 5.1.0-20201027-155758

File 3.1.0-20201016-065515

File & folders 1.1.0-20201023-202725

Folder 3.0.0-20201016-065517

FTP / SFTP 2.1.0-20200921-085757

IF/ELSE 2.1.0-20200921-085758

Image Recognition 2.1.0-20201014-042552

Moduli interattivi 2.17.3-20201102-103733

IQ Bot 2.1.0-20201013-095304

JavaScript 2.3.0-20201104-062431

Simulate keystrokes 2.4.0-20201021-163833

Legacy Automation 3.2.0-20201104-062439
1.3.0-20201105-151906
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Pacchetto Versione

List 2.2.0-20201014-042806

Log To File 2.2.0-20201014-042806

Loop 2.1.0-20201014-042808

Message Box 2.1.0-20201014-042808

Migrazione 2.7.0-20201106-072418

Mouse 2.1.0-20201014-042814

Number 2.1.0-20201014-042823

OCR 2.2.0-20201104-062503

Office 365 Excel 2.2.0-20201104-062559

Office 365 Calendar 2.1.0-20200921-085726

Office 365 OneDrive 2.1.0-20201014-042924

PDF 2.5.0-20201014-042929

PGP 2.2.0-20201014-042931

Ping 2.1.0-20201014-042932

Stampante 2.1.0-20200921-090131

Play Sound 2.1.0-20200921-090123

Prompt 2.1.0-20200918-081201

Python Script 2.3.0-20201105-204912

Recorder 2.0.9-20201105-164103

REST Web Service 3.1.0-20200928-231420

SAP 2.2.0-20200921-090209

Screen 2.1.0-20201014-043037

SNMP 2.1.0-20201014-043041

Servizio 3.0.0-20200921-090214

SOAP Web Service 3.1.0-20200921-090219

String 3.1.0-20201014-043052

System 3.0.0-20200921-090225

Attività 2.0.1-20201023-202703

Terminal Emulator 3.4.0-20201028-021451

Trigger Email 1.1.0-20201105-152220

VBScript 2.3.0-20201105-205228

Wait 3.1.0-20201014-043117

Window 2.2.0-20201022-121649

Workload 2.3.0-20201105-205233
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Pacchetto Versione

XML 2.1.0-20201014-043121

Sandbox environment
The sandbox environment for Automation 360 Cloud enables you to test your production bots to ensure
that these bots work seamlessly in your production environment. Use the sandbox environment to help
plan and test new features for upcoming Automation 360 releases.
The sandbox environment is the same as any Automation 360 Cloud instance but includes updates from
the upcoming new release at least 3 weeks before Automation Anywhere Cloud is updated.

Note:  The sandbox environment should not be used as your production environment.
IQ Bot non è incluso nell'ambiente sandbox.

The following image shows how a new build is tested in the sandbox environment before it is pushed to
the production environment.

Vantaggi

The environment provides the following benefits to the Automation 360 Cloud customers:
• Test new features and identify any changes that might be required in your current bots.
• Visualizzare l'anteprima delle funzionalità e dei miglioramenti imminenti.
• Pianificare e gestire meglio le modifiche per il prossimo aggiornamento dell'ambiente.

L'ambiente sandbox è disponibile solo per distribuzioni Automation 360 cloud e abilitate al cloud. The
environment is not supported for a Control Room in a data center that is hosted by you or a third-party
vendor. The environment includes upcoming updates for Automation 360, Discovery Bot, Document
Automation, AARI, and Bot Insight.
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Prerequisiti

• You must have a valid Automation 360 Cloud license to use the sandbox environment.
• Devi acquistare una SKU sandbox ordinabile.

Per ulteriori dettagli, contatta il tuo Customer Success Manager (CSM) o Partner Enablement Manager
(PEM).

Configurare l'ambiente

Prima di iniziare a utilizzare l'ambiente, esegui le seguenti operazioni:
1. Rimuovi l'assegnazione di alcune licenze dalle istanze Automation 360 esistenti e assegnale

all'ambiente sandbox.
2. Switch Bot Agent to the sandbox environment.
3. Crea gli utenti, i ruoli e altre entità Automation 360 Cloud richieste nell'ambiente:

• Create a user on page 2684
• Create a role on page 2693
• Credentials and lockers in the Credential Vault on page 2839

4. Export bots from your existing Automation 360 Cloud.
5. Import the exported bots to the sandbox environment using Bot Lifecycle Management.

See also:
• Automation 360 software lifecycle policy on page 742
• Automation 360 Cloud updates on page 756

Automation 360 Package SDK Release Notes
Review the new, changed, fixed, and deprecated features, and security fixes, known issues, and limitations
for the Automation 360 (formerly Enterprise A2019) Package SDK.
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Miglioramenti a Automation 360 v.27

Funzionalità Descrizione

Added new annotations Added documentation_url and tutorial_url in
CommandPkg.
1. documentation_url - Use this to add a

documentation link to an action.
2. tutorial_url - Use this to add a video

tutorial link to an action.
Ad esempio:

@CommandPkg(
        node_label =
 "[[CMtoINCH.node_label]]",
        label =
 "[[CMtoINCH.label]]",
        description =
 "[[CMtoINCH.description]]",
        name = "CMtoInch",
        icon =
 "ruler_icon.svg",
        documentation_url =
 "https://example.com/doc/
CMtoINCH.html",
        tutorial_url =
 "https://example.com/
tutorial/CMtoINCH.html",
       
 minimum_controlroom_version =
 "13980",
       
 minimum_botagent_version =
 "21.210")

A360-package-sdk-2.6.1.zip

Miglioramenti a Automation 360 v.25

Funzionalità Descrizione

Aggiunto il valore predefinito session_value È stato aggiunto default_session_value
in CommandPkg per impostare il valore
predefinito per la sessione globale.

A360-package-sdk-2.5.0.zip
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Miglioramenti a Automation 360 v.23

Funzionalità Descrizione

Versione di Log4j Log4j è stato aggiornato alla versione 2.17.1.

A360-package-sdk-2.4.1.zip

Miglioramenti a Automation 360 v.22

Funzionalità Descrizione

Pacchetto ridenominato Il nome del pacchetto è stato ridenominato da
A2019 a A360.

Aggiunte impostazioni di ritorno Sono state aggiunte le impostazioni di ritorno
per CommandPkg per decidere le impostazioni
o le configurazioni relative al tipo di ritorno del
comando.

Aggiunta nuova annotazione È stata aggiunta una nuova annotazione per
SessionObject per indicare che l'oggetto della
sessione viene trasferito al comando.

Aggiunta nuova annotazione È stata aggiunta una nuova annotazione per
SessionAllowNonExistent per indicare che
una sessione non esistente può essere trasferita
al comando.

Aggiunto nuovo tipo di attributo È stato aggiunto un nuovo tipo di attributo
BAPIOBJECT che funziona con il tipo di
controllo denominato BAPIWORKFLOW con le
seguenti tre tabelle.
• Importa
• Esporta
• Tabella

Aggiunte impostazioni di ritorno multiple Sono state aggiunte impostazioni di ritorno
multiple in CommandPkg per restituire più
valori dal comando.

Aggiornamenti della libreria di runtime Sono state raggruppate le librerie di runtime più
recenti del bot.

A360-package-sdk-2.3.0.zip

Miglioramenti a Automation 360 v.21

Funzionalità Descrizione

Aggiunta nuova annotazione È stata aggiunta la nuova annotazione per la
Control Room e per l'Bot Agent.
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Funzionalità Descrizione

Aggiunta nuova annotazione È stata aggiunta la nuova annotazione
per la password delle credenziali
(@CredentialAllowPassword).

Aggiunto nuovo esempio È stato aggiunto il nuovo esempio in:
 botcommand/samples/commands/
basic/types, denominato file
CredentialTypeDemo.java.

Aggiunta nuova annotazione È stata aggiunta la nuova annotazione per
supportare l'interfaccia Trigger3.

Aggiornati gli esempi di trigger Sono stati aggiornati gli esempi di trigger per
supportare l'interfaccia Trigger3.

Aggiornamenti della libreria di runtime Le librerie di runtime più recenti del bot sono
state raggruppate.

A2019-package-sdk-2.1.0

Miglioramenti a A2019.20

Funzionalità Descrizione

Aggiornamenti della libreria di runtime Le librerie di runtime più recenti del bot sono
state raggruppate.

A2019-package-sdk-2.0.9

Miglioramenti a Enterprise A2019.19

Funzionalità Descrizione

Aggiornamenti della libreria di runtime Le librerie di runtime più recenti del bot sono
state raggruppate.

Aggiunta regola di annotazione È stata aggiunta la regola di annotazione
MultipleRecordPicker annotation rule.

Aggiunte annotazioni Sono state aggiunte annotazioni per le fasi
operative del desktop.

A2019-package-sdk-2.0.8

Miglioramenti a Enterprise A2019.18

Funzionalità Descrizione

Aggiornamenti della libreria di runtime Le librerie di runtime più recenti del bot sono
state raggruppate.
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Funzionalità Descrizione

Aggiunta sessione condivisa È stato aggiunto il supporto per le sessioni
condivise.

Migliorata la creazione delle proprietà Ora le proprietà possono accettare un
parametro.

Aggiunta regola per WindowResize e
WindowBrowser

È stata aggiunta una nuova regola per
WindowResize e WindowBrowser.

Dipendenze non essenziali in build.gradle
impostate come commento

Le dipendenze non essenziali in build.gradle
sono ora impostate come commento e possono
essere abilitate per compilare gli esempi del
pacchetto SDK.

A2019-package-sdk-2.0.7

Miglioramenti a Enterprise A2019.17

Funzionalità Descrizione

Aggiornamenti della libreria di runtime Le librerie di runtime più recenti del bot sono
state raggruppate.

Aggiunto nome dell'autore nei pacchetti
personalizzati

È stato integrato il supporto per aggiungere
il nome dell'autore nella colonna fornitore dei
pacchetti personalizzati.

Aggiunto attributo File2 È stato aggiunto il nuovo tipo di attributo File2.

Aggiunta regola Tipo di file È stata aggiunta la nuova regola Tipo di file.

A2019-package-sdk-2.0.6

Miglioramenti a Enterprise A2019.16

Funzionalità Descrizione

Aggiornamenti della libreria di runtime Le librerie di runtime più recenti del bot sono
state raggruppate.

Aggiunto NoLogging È stato aggiunto il supporto per NoLogging.

A2019-package-sdk-2.0.5

Miglioramenti a Enterprise A2019.15

Funzionalità Descrizione

Aggiornamenti della libreria di runtime Le librerie di runtime più recenti del bot sono
state raggruppate.

© 2023 Automation Anywhere. All rights reserved.     713

https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019-package-sdk-2.0.7.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019-package-sdk-2.0.6.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019-package-sdk-2.0.5.zip


    Automation Anywhere - Learn

A2019-package-sdk-2.0.4

Miglioramenti a Enterprise A2019.14

Funzionalità Descrizione

Operazioni desktop È stato aggiunto il supporto delle operazioni
desktop.

Esempi per le azioni nel file di download Sono stati aggiunti altri esempi per le azioni nel
file di download del pacchetto SDK.

Aggiornamenti della libreria di runtime Le librerie di runtime più recenti del bot sono
state raggruppate.

A2019-package-sdk-2.0.3

Miglioramenti a Enterprise A2019.13

Funzionalità Descrizione

Convalida dell'ora per le impostazioni locali È stata aggiunta la convalida dell’ora di
compilazione per il file JSON delle impostazioni
locali.

Elenco di voci È stato aggiunto il supporto per ENTRYLIST.

Aggiornamenti della libreria di runtime Le librerie di runtime più recenti del bot sono
state raggruppate.

A2019-package-sdk-2.0.2

Miglioramenti a A2019.12.1

Funzionalità Descrizione

Esempi di trigger Sono stati aggiunti esempi di trigger nel file di
download del pacchetto SDK. Scarica il pacchetto
SDK più recente per accedere ai file di esempio.

A2019-package-sdk-2.0.1.zip

Miglioramenti a Enterprise A2019.12

Funzionalità Descrizione

Librerie di runtime Sono state aggiunte le librerie di runtime più
recenti.

Trigger personalizzato Questa versione supporta la creazione di trigger
personalizzati.
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Funzionalità Descrizione

Esempio Sono stati aggiunti altri esempi di codice.

È stato aggiunto l'esempio di codice
HierarchyDemo.java alla documentazione del
pacchetto. (ID caso Service Cloud: 00469066)

Crea un'azione semplice con diverse scelte.
L'interfaccia utente differisce in base alle opzioni
selezionate.

A2019-package-sdk-2.0.0.zip

Miglioramenti a A2019.11

Funzionalità Descrizione

Librerie di runtime Questo pacchetto contiene le librerie di runtime
più recenti.

A2019-package-sdk-1.0.11.zip

Miglioramenti a Enterprise A2019.10

Funzionalità Descrizione

Aggiornato il supporto per le annotazioni È stato aggiunto il supporto per le annotazioni di
nuovi attributi.

Bundle dell'SDK migliorato Doc java inserito nello zip del pacchetto SDK.
Ora dovrai semplicemente scaricare un file zip.

Librerie di runtime Le librerie di runtime del bot più recenti sono
state raggruppate.

Altri esempi Sono stati aggiunti nuovi esempi all'interno del
file zip.

Tipi di dati Sono stati aggiunti nuovi tipi di dati.

A2019.10-package-sdk-1.0.0.zip

Note:  Tutti i componenti del pacchetto SDK sono inclusi in un singolo file zip a partire dalla versione
A2019.10.

Miglioramenti a Enterprise A2019.09

Funzionalità Descrizione

Librerie di runtime del Bot Le librerie di runtime più recenti del bot
sono state raggruppate per il pacchetto SDK
A2019.09.

• Pacchetto demo SDK: A2019.09-packageSDK-1.0.0.zip
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• Documentazione: A2019.09-package-annotations-javadoc.zip

Miglioramenti a Enterprise A2019.08

Funzionalità Descrizione

Librerie di runtime del Bot Le librerie di runtime più recenti del bot
sono state raggruppate per il pacchetto SDK
A2019.08.

Supporto delle proprietà È stato ampliato il supporto per le proprietà.

Commenti ampliati e migliorati Sono stati aggiunti altri commenti ai comandi di
esempio per facilitare l'utilizzo dell'SDK.

Formattazione dei campi dei commenti Sono stati aggiunti il colore del testo e il colore di
sfondo ai campi dei commenti.

• Pacchetto demo SDK: A2019.08-packageSDK-1.0.0.zip
• Documentazione: A2019.08-package-annotqations-javadoc.zip

Miglioramenti a A2019.07

Funzionalità Descrizione

Librerie di runtime del Bot Le librerie di runtime del bot A2019.07 sono
raggruppate nel pacchetto SDK.

Attributo CREDENZIALI Forniamo supporto per gli attributi delle
credenziali che richiedono l'input dalle schermate
delle azioni.

Testo dell'interfaccia utente per azioni e
messaggi di errore localizzati

Consente di sviluppare pacchetti di interfaccia
utente con messaggi di errore internazionalizzati
e testo localizzato delle azioni dell'interfaccia
utente.

Kit di sviluppo Java 11 Il kit di sviluppo pacchetto A2019.07 supporta
JDK 11.

• Pacchetto demo SDK: A2019.07-Package-Sdk-1.0.0.zip
• Documentazione: A2019.07-package-annotations-javadoc.zip

Process Discovery Release Notes
Review the new features and improvements in each release.
Utilizza i link per visualizzare gli aggiornamenti delle note sulla versione per ogni versione.
For information related to features and fixes in previous Process Discovery releases, see the PDFs for these
releases: Process Discovery documentation (release versions).
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Process Discovery Version 1.63.0 Release Notes
Review the new fixes available in this release.
Release Date: 21-February-2023
For information related to features and fixes in previous Process Discovery releases, see the PDFs for these
releases: Process Discovery documentation (release versions).

Funzionalità

From the Manage Users page, Process Discovery Admins can create their own login password for the Event
Reporting interface.

Note:  The Event reporting interface is your Kibana account.

Create your event reporting password on page 2287

Correzioni

• You can view the step count for each process from the Mining Runs, Process Explorer, Process View,
and Processes pages. For each process, the step count should be the same across all pages. Previously,
when you viewed the step count from the Processes page, the step count was incorrect.

• You can select any Mining IDs in the Filters option, even when the mining run you created generates
no paths. Previously, when you created a mining run and no paths were found (the Status column is
updated to display the path status), you could not search the path using the Mining ID.

• The Observer activity dashboard displays data collected for the observers. Previously, the dashboard
displayed zero bytes in the Data Collected graph and zero events in the Events Collected graph.

• You can configure the Observer activity settings even when the Windows username (username listed
in the Users column) contains a period. Previously, if the username contained a period, and you
configured the Observer settings for that observer, a server error occurred.

Neo Sensor Version 2.4.1
Review the new feature and fixed issues available in this release.
Release Date: 18-November-2022
Feature and Fixed issues
Contact your Customer Success Manager (CSM) or Partner Enablement Manager (PEM) for the latest
version. For information related to features and fixes in the previous Neo Sensor release, see the PDFs for
these releases: Process Discovery documentation (release versions). Neo Sensor Version 2.4.1 includes the
following updates:
Feature
You can now adjust the Neo Senor debug level, and the log will contain more details regarding the
screenshots taken by the application. For example, the Area of Interest screenshot size and actions is
detailed in the log. To adjust the debug level, set the debug value to one of the following in the NeoConfig
json configuration file:
• Set DEBUG to 1 in the installer.
• Set Debug to 1 in the registry.
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• Set debug to 1 in the NeoConfig json configuration file if running in portable mode.

Fixed issues
For Observer Users that have a multi-monitor setup and the ScreenFullCapture setting is disabled, you
can now view the screenshot taken on the correct monitor. Previously, only the Primary monitor was used
in making the comparison between the screenshot taken and the desktop size.
You can now use two different methods to determine where an application’s screen is located. You
can adjust the SCREEN_FETCH_METHOD in the installer, ScreenFetchMethod in the registry, or
screenFetchMethod in the NeoConfig json configuration file if running in portable mode with one of these
values:
• 1 (default value) will use the center of the active window to determine the position.
• 2 will use the active windows reported handle from Microsoft Windows.

CoE Manager Release Notes
Review the CoE Manager feature available in Automation 360 v.26 release.

Introduction

Use CoE Manager - powered by Shibumi to scale your automation programs more quickly and efficiently.
CoE Manager provides visibility into your end-to-end automation lifecycle and accelerates pipeline
generation. It provides a consistent way of assessing automation opportunities which helps in minimizing
the variations and maximizing the ROI.
CoE Manager is available out of the box and requires minimal configuration for first-time use.

Compatibilità di Automation Anywhere Enterprise

Automation 360: The Control Room can be a Cloud or On-Premises deployment.
CoE Manager on page 2926.

Browser extensions for Automation 360
Crea automazione dai browser supportati utilizzando le estensioni del browser. Le estensioni sono
aggiornate periodicamente per supportare i miglioramenti e le correzioni delle funzionalità. Pertanto,
assicurati di disporre delle versioni più aggiornate delle estensioni per i browser Google Chrome, Microsoft
Edge e Mozilla Firefox.
Before you download the latest version of a browser extension, review the information in the following
tables:
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Browser extension for Manifest V3

Nome
estensione

Versione
dell'estensione

Correzioni Collegamento
all'estensione

Google
Chrome

3.0.8.0 During web automation, the web page maintains its
position when the target object is already visible on
the page. This improves the automation reliability
when there is a fixed pane on the web page and
physical actions (such as mouse click) do not work as
expected.

Google Chrome
extension for
Automation 360

Microsoft Edge
basato su
Chromium

3.0.8.0 During web automation, the web page maintains its
position when the target object is already visible on
the page. This improves the automation reliability
when there is a fixed pane on the web page and
physical actions (such as mouse click) do not work as
expected.

Microsoft Edge
extension for
Automation 360

Browser extensions for Manifest V2

Impact to our customers: Automations that use Google Chrome Manifest V2 based extensions will
stop working sometime after June 2023. The deprecation timelines of Manifest V2 based extensions are
currently under review and subject to change by Google.
• For Google Chrome Manifest V2 extensions timelines, see Manifest V2 support timeline.
• For Microsoft Edge Manifest V2 extensions timelines, see Overview and timelines for migrating to Manifest

V3.

Nome estensione Versione dell'estensione Collegamento all'estensione

Google Chrome 1.7.0.0 Automation 360 extension for
Chrome

Microsoft Edge basato su
Chromium

1.7.0.0 Automation 360 extension for
Microsoft Edge

Mozilla Firefox 1.7.0.0 Automation 360 extension for
Mozilla Firefox

Related concepts
Note sulla versione Automation 360 on page 63
Esamina le nuove capacità, le modifiche, le correzioni (problemi risolti), le correzioni di sicurezza, le
funzionalità obsolete e le limitazioni di ogni versione.
Related reference
Requisiti del browser per RPA Workspace on page 866
Accedi all'interfaccia RPA Workspace da un browser. After you have installed and enabled extensions in
the browser, perform several tasks through the RPA Workspace interface based on your user role and
automation requirements.
Compatibilità di Bot Agent on page 1025
Prima di installare Bot Agent, assicurati che sia compatibile con l'hardware e il software del tuo ambiente.
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Browser extensions for web applications
You can create automations using the Google Chrome and Microsoft Edge browser extensions for web
applications running on Google Chrome and Microsoft Edge, which enables you to automate with enhanced
security and performance.

Features using browser extensions for web applications

The following Automation 360 features use the browser extensions for web applications running on Google
Chrome or Microsoft Edge browsers:
• Automation of web applications through Universal Recorder or Browser package
• User interface-based triggers
• Bot Agent device registration with the Control Room
• Packages that use window titles, for example, OCR and Mouse > Click.

Use browser extensions to automate web applications

To automate web applications, the browser extensions capture the properties of the targeted UI elements,
application window title, and URL that enables you to create or update the actions that are specific to
the Recorder in the bots. Newly created or updated bots are then uploaded from the browser of the Bot
Creator to the Control Room. All bots are stored in the Control Room along with the properties of the UI
element. When a bot is running, browser extensions are used to automate actions on the targeted UI
elements of the web-based business applications.
When a Bot Creator or a Bot Runner user connects to the Control Room for the first time over Google
Chrome or Microsoft Edge browsers, the browser extensions enable you to register your device by
automatically sharing the device name and windows username, with the Control Room.

Note:  Firefox browser extension supports object-based automation of web applications running in Firefox
browser. Registering your device over Firefox browser is not yet supported.

Previous versions of browser extensions
Review the version history of browser extensions from past releases.

Version 3.0.7.0

Nome estensione Correzioni

Google Chrome • Timeout issues no longer occur on websites that
previously had high loading time because now the
JavaScript with debugger is performed successfully
on any page that has a CSP policy.

• Fix provided for document.evaluate if
the document.querySelector is blocked.
Previously, user interaction functions on some
websites were not available because the
document.querySelector was blocked.
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Nome estensione Correzioni

Microsoft Edge basato su Chromium • Timeout issues no longer occur on websites that
previously had high loading time because now the
JavaScript with debugger is performed successfully
on any page that has a CSP policy.

• Fix provided for document.evaluate if
the document.querySelector is blocked.
Previously, user interaction functions on some
websites were not available because the
document.querySelector was blocked.

Version 3.0.6.0

Nome estensione Correzioni

Google Chrome • Enhancement to add case sensitivity option for
static window titles in Google Chrome and Microsoft
Edge

• Fixes to capture objects and perform selected
actions in a migrated bot using Recorder in Google
Chrome and Microsoft Edge

• Fixes to run JavaScript after executing Recorder
actions in a bot in Google Chrome and Microsoft
Edge

• Fixes to capture pop-up windows with Automation
360 plug-in enabled in Google Chrome and
Microsoft Edge.

Microsoft Edge basato su Chromium • In the Recorder package, you can now use the
Click or Left click action on the JavaScript alert,
prompt, and confirmation pop-up windows to
automate web pages on Microsoft Edge browser.

• In the package, you can now use the Click for the
Link and Form tag controls that have inline scripting
with using Manifest V3 extensions.

Version 3.0.5.0

Nome estensione Correzioni

Google Chrome

Microsoft Edge basato su Chromium
• Correzioni per eseguire JavaScript all'interno

di un iFrame in Google Chrome.
• Miglioramento per escludere il caricamento

della pagina per le pagine predefinite in
Google Chrome e Microsoft Edge
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Matrice di confronto delle funzionalità per Automation 360
Puoi utilizzare la matrice di confronto delle funzionalità per confrontare le funzionalità di Automation 360
con le funzionalità di Automation Anywhere Enterprise 11.3.x e delle versioni Enterprise 10.
Per i dettagli sulle ultime funzionalità e miglioramenti, consulta le note sulla versione di Automation 360.

Componenti principali

Automation 360 Enterprise 11.3.x Enterprise 10.x

Utente a cui è destinata Citizen developer
Specialista/
sviluppatore RPA
IT

Sviluppatore RPA
IT

Sviluppatore RPA
IT

Modello di distribuzione On-Premises
Cloud
Abilitato al cloud

On-Premises On-Premises
BotFarm (per Bot
Runners)

Sistema operativo Microsoft Windows
Linux (Linux CentOS
7.7, 7.9 e 8.3) e
(Red Hat Enterprise
Linux 7.7, 7.9 e 8.3)

(Sistema operativo non
applicabile per Cloud)

Microsoft Windows Microsoft Windows

Supporto di Microsoft
Active Directory

Disponibile Disponibile Disponibile

SAML 2.0 Disponibile Disponibile Non disponibile

Supporto proxy
autenticato

Disponibile Non disponibile Non disponibile

Interfaccia utente (UI)
localizzata

Oltre 15 lingue 3 lingue Non disponibile

Supporto di Bot Insight Disponibile Disponibile Disponibile (base)

Supporto di IQ Bot Disponibile Disponibile Disponibile (base)

Supporto dei moduli
interattivi (automazione
assistita)

Disponibile Non disponibile Non disponibile

Piattaforma Bot Creator On premises thin client Thick client Thick client

Piattaforma Bot Runner Distribuita in rete Thick client Thick client

bots assistito Disponibile Disponibile Non disponibile

bots non assistito Disponibile Disponibile Disponibile
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Automation 360 Enterprise 11.3.x Enterprise 10.x

Aggiornamento per
l'uso di nuovi comandi
o nuove actions

Nessun
aggiornamento
richiesto per Cloud
Aggiornamento
richiesto per On-
Premises e per
abilitato al cloud

Aggiornamento
richiesto

Aggiornamento
richiesto

Accodamento
automatizzato per il
processo

Disponibile Disponibile Non disponibile

Gestione centralizzata
delle licenze

Disponibile Disponibile Disponibile

Disponibilità elevata Disponibile Disponibile Disponibile

Bilanciamento del
carico

Disponibile Disponibile Disponibile

Ripristino di emergenza Disponibile Disponibile Disponibile

Supporto multidominio Disponibile Disponibile Disponibile

Tecnologia di hosting Java • Java (Control Room)
• Microsoft .NET

Framework
(Enterprise Client)

Microsoft IIS

Accesso basato sui ruoli Disponibile Disponibile Disponibile

Power BI Disponibile Non disponibile Non disponibile

Connettore Tableau per
Bot Insight

Disponibile Non disponibile Non disponibile

Controllo delle versioni Disponibile tramite
integrazione Git
(Subversion obsoleta)

Disponibile tramite
integrazione subversion

Disponibile tramite
integrazione subversion

Integrazione Syslog Disponibile Disponibile Non disponibile

Funzionalità server Control Room

Funzionalità Automation 360 Enterprise 11.3.x Enterprise 10.x

Controllo delle versioni
- Impostazione della
versione di produzione

Disponibile Disponibile Disponibile

Controllo delle versioni
- Confronto tra due
versioni di un bot

Disponibile Disponibile Disponibile
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Funzionalità Automation 360 Enterprise 11.3.x Enterprise 10.x

Controllo delle
versioni - consente
di controllare la
cronologia delle
versioni

Disponibile Disponibile Disponibile

Controllo delle versioni
- Tornare alla versione
precedente

Disponibile Disponibile Disponibile

Autenticazione a due o
più fattori

Disponibile (tramite
SSO)

Disponibile (nativo e
tramite SSO)

Non disponibile

Testo banner
all'accesso a Control
Room

Disponibile Disponibile Non disponibile

Installa Control Room
su Oracle Database

Disponibile Disponibile Non disponibile

Log di audit Disponibile Disponibile Disponibile

Apri la pagina Web in
una nuova scheda di
Internet Explorer

Disponibile Disponibile Disponibile

Apri la pagina Web in
una nuova scheda di
Google Chrome

Disponibile Non disponibile Non disponibile

Impostazione per
una nuova sessione
di accesso in Control
Room

Obsoleto Disponibile Non disponibile

Configura la durata
delle chiavi API

Disponibile Non disponibile Non disponibile

Configura la verifica
dell'e-mail alla
creazione dell'utente

Disponibile Disponibile Non disponibile

Abilita l'accesso di
debug

Disponibile Disponibile Non disponibile

Sviluppo di Bot

Funzionalità Automation 360 Enterprise 11.3.x Enterprise 10.x

Apprendimento nel
prodotto

Disponibile Non disponibile Non disponibile

Vista flusso Bot Creator Disponibile Non disponibile Non disponibile

Vista doppia Bot
Creator

Disponibile Non disponibile Non disponibile
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Funzionalità Automation 360 Enterprise 11.3.x Enterprise 10.x

Visualizzazione codice
Bot Creator

Disponibile Disponibile Disponibile

Visualizzazione vista
Bot Creator

Non disponibile Disponibile Disponibile

Ricerca azioni Disponibile Non disponibile Non disponibile

Ricerca di testo Disponibile Disponibile Disponibile

Espressioni avanzate Disponibile Disponibilità limitata Disponibilità limitata

Espressioni regolari Disponibile Disponibile Disponibile

Test dei dispositivi
remoti

Disponibile
(Sviluppo su un
dispositivo e test su un
altro dispositivo)

Non disponibile Non disponibile

Azioni localizzate Disponibile Non disponibile Non disponibile

Sviluppo collaborativo Disponibile Non disponibile Non disponibile

Integrazione di Bot
Store

Disponibile Disponibile (Version
11.3.3 e versioni
successive)

Non disponibile

Trigger e-mail Disponibile Disponibile Disponibile

Trigger file e cartelle Disponibile Disponibile Disponibile

Trigger tasti di scelta
rapida

Disponibile Disponibile Disponibile

Trigger interfaccia
utente

Disponibile Non disponibile Non disponibile

Trigger di prestazioni Non disponibile Disponibile Disponibile

Trigger di processo Disponibile Disponibile Disponibile

Trigger di servizio Disponibile Disponibile Disponibile

Trigger di finestre Disponibile Disponibile Disponibile

MetaBot Logic Disponibile tramite
TaskBot

Disponibile Disponibile

MetaBot DLL Disponibile tramite
DLL: Azione Esegui
funzione

Disponibile Disponibile

Ricalibrazione delle
schermate dei MetaBot

Non disponibile Disponibile Disponibile

Bot Lifecycle
Management - Import
and export bots

Disponibile Disponibile Non disponibile

Valori globali Disponibile Non disponibile Non disponibile

Clonazione di Bot Disponibile Non disponibile Non disponibile
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Funzionalità Automation 360 Enterprise 11.3.x Enterprise 10.x

Distribuzione API Disponibile Disponibile Non disponibile

Sessioni di Bot Runner
in Control Room

Disponibile Disponibile Disponibile

Dipendenze Bot
pacchetto

Disponibile Disponibile Disponibile

Ignora il disclaimer
di limitazione della
responsabilità

Disponibile Disponibile Disponibile

Modifica nome variabile Disponibile Disponibile Disponibile

Copia i comandi da un
bot all'altro

Disponibile
L'opzione Trigger non è
disponibile.

Disponibile Disponibile

Salva bot come XML/
TXT

Non disponibile Disponibile Disponibile

Disabilita mouse e
tastiera per il bot

Non disponibile Disponibile Disponibile

Esegui bot in modalità
stealth

Non disponibile Disponibile Disponibile

Visualizzare o
nascondere gli errori
durante l'esecuzione di
bot.

Non disponibile
(obsoleto per
Automation 360)

Disponibile Disponibile

Copia le variabili da un
bot all'altro

Disponibile Disponibile Disponibile

Supporto per iFrame
interdominio nei
browser.

Disponibile
Supportato in Google
Chrome e Microsoft
Edge.

Disponibile
Supportato in Internet
Explorer.

Disponibile
Supportato in Internet
Explorer.

Estendibilità di Bot e riutilizzo del codice

Funzionalità Automation 360 Enterprise 11.3.x Enterprise 10.x

actions personalizzate
nella tavolozza

Disponibili (è possibile
crearle utilizzando il kit
di sviluppo pacchetti)

Non disponibile Non disponibile

Scripting in linea Disponibile in Python,
VBScript e JavaScript

Disponibile in VBScript Non disponibile

Riutilizzo del codice Disponibile per i
TaskBots, actions
personalizzate e DLL

Disponibilità limitata
per i MetaBots e le DLL

Disponibilità limitata
per MetaBots e DLL
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Funzionalità Automation 360 Enterprise 11.3.x Enterprise 10.x

Mappa rapida per
variabili

Disponibile Disponibile Disponibile

Timeout Bot Disponibile Disponibile Disponibile

Priorità Bot Disponibile Disponibile Disponibile

Condivisione di sessioni
DLL

Disponibile Non disponibile Non disponibile

Esegui bot riutilizzando
la configurazione
dell'esecuzione
passata dalla pagina
Cronologia

Disponibile Disponibile Non disponibile

Funzionalità di integrazione

Funzionalità Automation 360 Enterprise 11.3.x Enterprise 10.x

Callout che utilizzano lo
scripting in linea

Disponibili per Python,
VBScript e JavaScript

Non disponibile Non disponibile

API di Control Room Disponibile Disponibile Non disponibile

REST Web Service Disponibile Disponibile Disponibile

SOAP Web Service Disponibile Disponibile Disponibile

Capacità di utilizzo dei dispositivi

Funzionalità Automation 360 Enterprise 11.3.x Enterprise 10.x

Gestione del carico di
lavoro

Disponibile Disponibile Non disponibile

Pool di dispositivi Available for scheduling
and workload
management

Available in workload
management only

Non disponibile

Pool di utenti
Esegui come per le
automazioni

Disponibile
Configurazione di più
utenti Esegui come per
i pool di dispositivi per
fornire una licenza e un
utilizzo dei dispositivi
efficaci

Non disponibile Non disponibile

Elaborazione in
background

Disponibile Non disponibile Non disponibile
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Funzionalità Automation 360 Enterprise 11.3.x Enterprise 10.x

Infrastruttura desktop
virtuale (Virtual
Desktop Infrastructure,
VDI) non permanente

Disponibile Disponibile Disponibile

Capacità del registratore

Funzionalità Automation 360 Enterprise 11.3.x Enterprise 10.x

AISense Recorder Disponibile Disponibile Non disponibile

Registratore unificato Disponibile (include il
supporto per Microsoft
Edge Chromium)
• L'estrazione dei dati

basati su modelli
non è disponibile

• Microsoft Edge
Legacy e Flash/Flex
sono obsoleti

Non disponibile
(capacità di
registrazione tramite
Web Recorder,
registratore intelligente
e registratore standard
o registratore dello
schermo)

Non disponibile
(capacità di
registrazione tramite
Web Recorder,
registratore intelligente
e registratore standard
o registratore dello
schermo)

Registratore per Web/
Windows

Disponibile Disponibile Disponibile

Registratore per SAP Disponibile Disponibile Non disponibile

Registratore per Citrix Disponibile Disponibile Non disponibile

Registratore per Oracle Disponibile Disponibile Non disponibile

Registrazione sicura Disponibile Disponibile Disponibile

Microsoft Silverlight 5
applicazioni desktop e
Web

Disponibile
(I controlli di terze parti
non sono disponibili)

Disponibile Disponibile

Scelta della tecnologia
di acquisizione sul
registratore

Disponibile Disponibile Disponibile

Bot packages

Funzionalità Automation 360
packages

Comandi di Enterprise
11.3.x

Comandi di Enterprise
10.x

AARI on the web Disponibile Non disponibile Non disponibile

Active Directory Disponibile Disponibile Disponibile

Analizza Disponibile Non disponibile Non disponibile

Application Disponibile Disponibile Disponibile
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Funzionalità Automation 360
packages

Comandi di Enterprise
11.3.x

Comandi di Enterprise
10.x

App Integration Disponibile Disponibile Disponibile

Boolean Disponibile Non disponibile Non disponibile

Migrazione di Bot Disponibile Non disponibile Non disponibile

Browser Disponibile
Le seguenti azioni
sono disponibili solo
per il browser Google
Chrome:
• Chiudi
• Ottieni codice

sorgente
• Vai indietro
• Esegui JavaScript

Disponibile (tramite
Web Recorder)
I comandi Web
Recorder sono
disponibili solo per
il browser Internet
Explorer.

Disponibile (tramite
Web Recorder)
I comandi Web
Recorder sono
disponibili solo per
il browser Internet
Explorer.

Citrix Automation Non disponibile
(Obsoleto e sostituito
da Registratore
unificato)

Disponibile Disponibile

Clipboard Disponibile Disponibile Disponibile

Comment Disponibile Disponibile Disponibile

Credential Vault Disponibile Disponibile Disponibile

CSV/TXT Disponibile Disponibile Disponibile

Data Table Disponibile Disponibile utilizzando
la variabile di tipo
matrice

Disponibile utilizzando
la variabile di tipo
matrice

Database Disponibile Disponibile Disponibile

Datetime Disponibile Non disponibile Non disponibile

Delay Disponibile Disponibile Disponibile

Dictionary Disponibile Non disponibile Non disponibile

DLL Disponibile Disponibilità limitata
tramite MetaBots

Disponibilità limitata
tramite MetaBots

Email Disponibile (SMTP, EWS
e Outlook)
Le opzioni seguenti non
sono disponibili:
• Invio e-mail con

modello
• Aggiungi

un'immagine
all'interno dell'e-mail

Disponibile (SMTP,
EWS)

Disponibile (SMTP)
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Funzionalità Automation 360
packages

Comandi di Enterprise
11.3.x

Comandi di Enterprise
10.x

Error handler Disponibile (Avanzato
- Try, Catch, Finally,
Throw)

Disponibile (base) Disponibile (base)

Excel advanced Disponibile Disponibilità limitata Disponibilità limitata

Excel basic (senza
Excel)

Disponibile Non disponibile Non disponibile

Operazioni File Disponibile Disponibile Disponibile

Operazioni Folder Disponibile Disponibile Disponibile

FTP / SFTP Disponibile Disponibile Disponibile

If Disponibile Disponibile Disponibile

Image Recognition Disponibile Disponibile Disponibile

Operazioni moduli
interattivi

Disponibile Non disponibile Non disponibile

Internet Connection Non disponibile
(obsoleto per
Automation 360)

Disponibile Disponibile

IQ Bot Disponibile Disponibile Disponibile

Pre-processore IQ Bot Disponibile Non disponibile Non disponibile

IQ Bot (Dispositivo
locale)

Obsoleto Non disponibile Non disponibile

JavaScript Disponibile Disponibile tramite
Esegui script

Disponibile tramite
Esegui script

Automazione legacy
(per bots migrati)

Disponibile (per la
migrazione)

Non disponibile Non applicabile

Operazioni List Disponibile Non disponibile Non disponibile

Log To File Disponibile Disponibile Disponibile

Loop Disponibile Disponibile Disponibile

Message Box Disponibile Disponibile Disponibile

Schermate MetaBot Non disponibile
(Sostituito con
Universal Recorder)

Disponibile Disponibile

Mouse Disponibile Disponibile Disponibile

Number Disponibile Non disponibile Non disponibile

OCR Disponibile Disponibile Disponibile

Office 365 Calendar Disponibile Non disponibile Non disponibile

Office 365 Excel Disponibile Disponibile (desktop) Non disponibile

Office 365 OneDrive Disponibile Non disponibile Non disponibile
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Funzionalità Automation 360
packages

Comandi di Enterprise
11.3.x

Comandi di Enterprise
10.x

One Drive Disponibile Non disponibile Non disponibile

PDF Disponibile Disponibile Disponibile

PGP Disponibile Disponibile Disponibile

Play Sound Disponibile Disponibile Disponibile

Printer Disponibile Disponibile Disponibile

Prompt Disponibile Disponibile Disponibile

Python Script (In linea) Disponibile Non disponibile Non disponibile

Registra Disponibile Non disponibile Non disponibile

Recorder Disponibile Disponibile Disponibile

REST Web Service Disponibile Disponibile Disponibile

Supporto di SAP Disponibile (nativo) Disponibilità limitata
tramite MetaBots

Disponibilità limitata
tramite MetaBots

SAP BAPI Disponibile
Personalizzazione di
SAP BAPI sviluppate
non supportata.

Disponibile Disponibile

Screen Disponibile Disponibile Disponibile

Services Disponibile Disponibile Disponibile

Simulate keystrokes Disponibile Disponibile Disponibile

SNMP Disponibile Disponibile Disponibile

SOAP Web Service Disponibile Disponibile Disponibile

Step Disponibile Non disponibile Non disponibile

String Disponibile Disponibile Disponibile

System Disponibile Disponibile Disponibile

TaskBot Disponibile Disponibile Disponibile

Terminal Emulator Disponibile Disponibile Disponibile

File di testo Disponibile Non disponibile Non disponibile

Trigger Loop Disponibile Non disponibile Non disponibile

VBScript (In linea) Disponibile Disponibile come Run
Script

Non disponibile

Wait Disponibile Disponibile Disponibile

Window Disponibile Disponibile Disponibile

Workload Disponibile Disponibile Non disponibile

XML Disponibile Disponibile Disponibile

© 2023 Automation Anywhere. All rights reserved.     731



    Automation Anywhere - Learn

Supporto della variabili

Important:  Quando esegui la migrazione da versioni Enterprise 11.3.x o Enterprise 10 a Automation 360,
alcune variabili vengono mappate direttamente mentre altre contengono una configurazione differente.

Variabile Automation 360 Enterprise 11.3.x Enterprise 10.x

Variabili di applicazione

Analytics Disponibile Disponibile Non disponibile

ArrayRows Disponibile tramite
espressioni ricorsive

Disponibile Disponibile

ArrayColumns Disponibile tramite
espressioni ricorsive

Disponibile Disponibile

Clipboard Disponibile Disponibile Disponibile

Credential Disponibile Disponibile Non disponibile

Dictionary Disponibile tramite
Dictionary package

Disponibile Non disponibile

Enter (String variable) Disponibile Disponibile Disponibile

Prompt Assignment
(user-defined)

Disponibile Disponibile Disponibile

Read from Excel/CSV Disponibile tramite
Excel advanced
package

Disponibile tramite
variabile definita
dall'utente di tipo
matrice

Disponibile tramite
variabile definita
dall'utente di tipo
matrice

Read from database Disponibile tramite
Database package

Disponibile tramite
variabile definita
dall'utente di tipo
matrice

Disponibile tramite
variabile definita
dall'utente di tipo
matrice

Read from text file Disponibile tramite
CSV/TXT package

Disponibile tramite
variabili definite
dall'utente di tipo
matrice, elenco, valore

Disponibile tramite
variabili definite
dall'utente di tipo
matrice, elenco, valore

Separator (String
variable)

Disponibile Disponibile Disponibile

Tab (String variable) Disponibile Disponibile Disponibile

Work Item Disponibile Disponibile Non disponibile

Variabili di sistema

AAApplicationPath Disponibile tramite i
valori globali

Disponibile Disponibile

AADefaultDateFormat Disponibile tramite i
valori globali

Non disponibile Non disponibile

AAInstallationPath Disponibile Disponibile Disponibile

AATaskExecutor Disponibile Disponibile Non disponibile
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Variabile Automation 360 Enterprise 11.3.x Enterprise 10.x

AATaskName Disponibile Disponibile Non disponibile

AAControlRoom Disponibile Disponibile Non disponibile

Counter Disponibile tramite
Number e Loop
packages

Disponibile Disponibile

CPUUsage Disponibile Disponibile Disponibile

CurrentDirectory Disponibile tramite
Loop package

Disponibile Disponibile

DatasetColumn Disponibile tramite
Loop package

Disponibile Disponibile

Date Disponibile Disponibile Disponibile

Day Disponibile Disponibile Disponibile

Email (includes
EmailFrom,
EmailMessages,
EmailReceivedDate,
EmailReceivedTime,
EmailSubject, EmailTo,
EmailSentDate, and
EmailSentTime)

Disponibile tramite
Email, Dictionary e
Loop packages

Disponibile Disponibile

ErrorLineNumber Disponibile tramite
Error handler package

Disponibile Disponibile

ErrorDescription Disponibile tramite
Error handler package

Disponibile Disponibile

Excel (includes
ExcelColumn, ExcelCell,
ExcelCellColumn, and
ExcelCellRow)

Disponibile tramite
Excel advanced
package

Disponibile Disponibile

Extension Disponibile tramite
l'azione GetProperty di
PDF package

Disponibile Disponibile

FileDataColumn Disponibile come
variabile di tipo record
tramite il package Loop

Disponibile Disponibile

FileName Disponibile tramite il
pacchetto File

Disponibile Disponibile

FolderName Disponibile tramite il
pacchetto Folder

Disponibile Disponibile

Hour Disponibile Disponibile Disponibile

Machine Disponibile Disponibile Disponibile

Millisecond Disponibile Non disponibile Non disponibile

Minute Disponibile Disponibile Disponibile
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Variabile Automation 360 Enterprise 11.3.x Enterprise 10.x

Month Disponibile Disponibile Disponibile

OSName Disponibile Disponibile Disponibile

PDF (includes
PDFFileName, PDFTitle,
PDFAuthor, and
PDFSubject)

Disponibile tramite
l'azione GetProperty di
PDF package

Disponibile Disponibile

RAMUsage Disponibile Disponibile Disponibile

Second Disponibile Disponibile Disponibile

TableColumn Non disponibile Disponibile Disponibile

TotalRAM Disponibile Disponibile Disponibile

Trigger Disponibile tramite
Interface trigger

Disponibile Disponibile

Year Disponibile Disponibile Disponibile

XMLDataNode Disponibile come
variabile di tipo stringa
tramite il package Loop

Disponibile Disponibile

Related concepts
Note sulla versione Automation 360 on page 63
Esamina le nuove capacità, le modifiche, le correzioni (problemi risolti), le correzioni di sicurezza, le
funzionalità obsolete e le limitazioni di ogni versione.
Pacchetto SDK on page 2364
Il pacchetto SDK consente di creare e caricare pacchetti di azioni sulla tua Control Room.
Related reference
Sistema operativo, ambiente e piattaforma supportati per la Control Room on page 850
Automation 360 può essere ospitato su AWS, Microsoft Azure, Google Cloud Platform, IBM e su qualsiasi
servizio cloud pubblico, privato o ibrido che soddisfi i requisiti hardware e software per Control Room e Bot
Agent.
Domande frequenti su Automation 360 on page 51
Per i dettagli e le domande sulla piattaforma Automation Anywhere più recente, Automation 360, consulta
queste domande frequenti.
Mappatura delle variabili per la migrazione on page 1279
Nella migrazione, alcune variabili si mappano direttamente dalle versioni precedenti del prodotto a
Automation 360 mentre altre si comportano in modo diverso o contengono modifiche di configurazione.
Valori globali on page 2044
Global values enable users to reuse identical values between bots instead of creating new variables for
each bot. A user with the AAE_admin role configures a global value with a default value and can enable
non-admin users to overwrite the value to use in their bots.
Recursive expressions on page 2035
Use a recursive expression to insert a variable in the place of an index or key of a dictionary, list, record, or
table variable.
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Matrice di confronto delle funzionalità per Automation 360 IQ
Bot

Confrontare le caratteristiche chiave dei modelli di distribuzione di Automation 360 IQ Bot e esaminare la
parità delle caratteristiche con la versione 11.3.x di IQ Bot più recente.

Automation 360 IQ BotFunzioni di base di IQ Bot

On-Premises Cloud Community
Edition

IQ Bot
11.3.x

Domini predefiniti Sì Sì Sì
I domini
supportati
includono:
• Fatture
• Ordini

d'acquisto
• Estratti conto

bancari
• Nota di credito
• Bollette

Sì

Soglia di confidenza utente
in Validator

Sì No No Sì

Creazione/modifica
dell'istanza di
apprendimento /renaming

Sì Sì Sì Sì

Pre-elaborazione delle
immagini dei documenti

Sì Sì Sì Sì

Classificazione delle
immagini dei documenti

Sì Sì Sì Sì

Riconoscimento ottico del
carattere (Optical Character
Recognition, OCR) delle
immagini dei documenti

Sì Sì Sì Sì

OCR di Google Vision Sì Sì Sì Sì

Motore OCR dell’API Tegaki Sì No No Sì

Estrazione mediante
riconoscimento dei caratteri
con inchiostro magnetico
(Magnetic Ink Character
Recognition, MICR)

Sì Sì Sì Sì

Attiva/disattiva PDFBox Sì Sì Sì Sì

Caching (prestazioni
migliorate)

Sì Sì Sì Sì

Limitazione di Bot Sì Sì No Sì
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Automation 360 IQ BotFunzioni di base di IQ Bot

On-Premises Cloud Community
Edition

IQ Bot
11.3.x

Creazione/modifica/
eliminazione di Bot

Sì Sì Sì Sì

Designer/Anteprima/Test Sì Sì Sì Sì

Attivazione/Disattivazione
della produzione

Sì Sì Sì Sì

Validator Sì Sì Sì Sì

File di output CSV Sì Sì Sì Sì

Importazione/Esportazione
delle istanze di
apprendimento

Sì Sì No Sì

Convalide predefinite per
un gruppo

Sì Sì No Sì

Adding groups manually Sì Sì No No

CyberArk support Sì No No No

CyberArk support with key
rotation

Sì No No No

Automation 360 IQ BotFunzionalità di dominio/
formazione

On-Premises Cloud Community
Edition

IQ Bot 11.3.x

Interfaccia utente basata sul
web

Sì Sì Sì Sì

Importazione/Esportazione dei
domini

Sì Sì No Sì

Passaggio del mouse sopra
il segmento di testo per
visualizzare l'OCR

Sì Sì Sì Sì

Ridimensionamento della
casella mappata in Designer

Sì Sì Sì Sì

Eliminazione della casella
mappata in Designer

Sì Sì Sì Sì

Compilazione del testo in
Indicatore di fine tabella/
sezione

Sì Sì Sì Sì

Clic singolo per estrarre il
testo in Validator

Sì Sì Sì Sì

Descrizione del gruppo di
documenti

Sì Sì Sì Sì
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Automation 360 IQ BotFunzionalità di dominio/
formazione

On-Premises Cloud Community
Edition

IQ Bot 11.3.x

L'azione Guarda i risultati
dell'estrazione visualizza
l'elenco di tutti i documenti di
formazione in una sequenza
alfanumerica

Sì Sì Sì Sì

Lo strumento di installazione
delle patch InstallShield
con un processo di
aggiornamento/downgrade
semplificato per IQ Bot

Sì No No Sì

Configurazione delle
impostazioni di pre-
elaborazione dell'OCR

Sì No No No

Automation 360 IQ BotFunzionalità di estrazione/
convalida

On-Premises Cloud Community
Edition

IQ Bot 11.3.x

Segmentazione del testo/
Classificatore dei documenti
di IQ Bot originale da IQ Bot
versione 5.3.0/6.0

Sì No No Sì

Segmentazione del testo/
Classificatore dei documenti
di IQ Bot nuovo da IQ Bot
versione 5.3.1/6.5

Sì Sì Sì Sì

Opzione per selezionare la
versione del classificatore
delle istanze di apprendimento
esistenti durante
l'aggiornamento di IQ Bot:
• Versione 1 (IQ Bot 5.3.0 o

precedenti a 6.0)
• Versione 2 (IQ Bot 5.3.1/

Version 6.5 Beta

Sì No No Sì

Compatibilità migliorata con
il plug-in 12.2 di ABBYY
FineReader Engine

Sì Sì Sì Sì

Installazione automatizzata
del plug-in ABBYY FineReader
Engine 12.2

Sì Sì Sì Sì

Correzione automatica del
validator

Sì Sì Sì Sì
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Automation 360 IQ BotFunzionalità di estrazione/
convalida

On-Premises Cloud Community
Edition

IQ Bot 11.3.x

Estrazione delle caselle di
controllo

Sì Sì Sì Sì

Rilevamento automatico della
casella di controllo

Sì Sì Sì Sì

Estrazione avanzata: Tabelle/
sezioni ripetute; collegamento
di tabelle/sezioni; mappatura
di alcune colonne senza
intestazione

Sì Sì Sì Sì

Alternativa per interrompere
l'estrazione su Indicatore di
fine tabella/sezione

Sì Sì Sì Sì

Selezione di segmenti di testo
che includono o sono inclusi in
altri segmenti di testo

Sì Sì Sì Sì

Opzione per selezionare il
documento di formazione
predefinito

Sì Sì Sì Sì

Convalida della formula Sì Sì Sì Sì

Convalida dell'elenco
nell'interfaccia utente

Sì Sì Sì Sì

Convalida dell'elenco tramite
file esterno

No No No No

Validatore di ricerca file/
cartelle

Sì Sì Sì Sì

API Computer Vision (OCR)
Microsoft Azure

Sì Sì Sì Sì

Aggiunta di logica utente in
Designer

Sì Sì Sì Sì

View and test all documents
in the Designer > See
extraction results

Sì Sì Sì Sì

IQ Bot extensions Sì No No Sì

Importazione di domini di
moduli standard

Sì Sì No Sì

(Beta) Acquisizione dati
e OCR abilitati utilizzando
Google Vision API per le lingue
asiatiche

Sì Sì Sì Sì
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Automation 360 IQ BotFunzionalità di estrazione/
convalida

On-Premises Cloud Community
Edition

IQ Bot 11.3.x

Estrazione mediante
riconoscimento dei caratteri
con inchiostro magnetico
(Magnetic Ink Character
Recognition, MICR)

Sì Sì Sì Sì

Possibilità di disattivare
PDFBox come motore OCR

Sì Sì Sì Sì

Utilizzo delle variabili in IQ Bot
package

Sì Sì Sì No

I risultati dell'estrazione si
aprono in una nuova scheda
del browser

Sì Sì Sì No

Moduli standard IQ Bot Sì Sì No No

Automation 360 IQ BotFunzionalità Enterprise

On-Premises Cloud Community
Edition

IQ Bot 11.3.x

Accesso a IQ Bot senza licenza
di dispositivo (senza licenza di
Bot Creator o Bot Runner)

Sì Sì Sì Sì

Accesso a IQ Bot come utenti
di Validator senza licenza di
Bot Creator o Bot Runner

Sì Sì Sì Sì

Crittografia del database Sì Sì Sì Sì

Controllo degli accessi basato
sul ruolo (Role Based Access
Control, RBAC) per le nuove
istanze di apprendimento

Sì Sì No Sì

Audit logs Sì Sì No Sì

Autenticazione Windows Sì Sì No Sì

Servizio di database Azure
PaaS

Sì No No Sì

Contatore del numero di
pagine caricate in produzione

Sì Sì No Sì

Accesso API Sì Sì Sì Sì

Accesso a IQ Bot senza
ruolo sysadmin che include
il supporto per Amazon
Relational Database Service
(RDS) pronto all'uso

Sì No No Sì
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Automation 360 IQ BotFunzionalità Enterprise

On-Premises Cloud Community
Edition

IQ Bot 11.3.x

Migrazione delle istanze di
apprendimento mentre altre
istanze di apprendimento sono
in fase di modifica

Sì Sì No Sì

Interfaccia Utente dell'utilità di
migrazione

Sì Sì No Sì

Internazionalizzazione Sì Sì Sì Sì

Localizzazione dell'interfaccia
utente:
• Cinese semplificato
• Cinese tradizionale
• Francese
• Tedesco
• Giapponese
• Coreano
• Spagnolo
• Italiano
• Portoghese

Sì Sì Sì Sì

Automation 360 IQ BotPacchetti Automation 360

On-Premises Cloud Community
Edition

IQ Bot Classifier package Sì Sì No

IQ Bot [Local Device] package Sì Sì Sì

IQ Bot Pre-processor package Sì Sì Sì

IQ Bot Extractionpackage Sì Sì Sì

Related reference
Comparing Automation 360 and Enterprise 11 APIs on page 2992
Compare Automation 360 and Enterprise 11 APIs to understand the contract changes when you migrate
from Enterprise 11 to Automation 360.
Related information
IQ Bot 11.x feature comparison matrix

Compatibilità delle versioni di Automation 360 IQ Bot
Leggi le informazioni sulla compatibilità delle versioni prima di eseguire l'aggiornamento da una versione
di Automation 360 IQ Bot precedente alla versione di Automation 360 IQ Bot più recente o da versioni
precedenti di IQ Bot a Automation 360 IQ Bot.
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Compatibilità con Automation 360 Control Room

Compatibilità della versione Automation 360 IQ Bot On-Premises con Automation 360 Control Room:

Important:  The following table lists the latest build of each Control Room release that is compatible with
the IQ Bot build. Note that, IQ Bot is compatible with all Automation 360 builds in a release. For example,
Automation 360 v.21, IQ Bot build 9642 is compatible with Control Room build 9664 and builds released
after that such as 9595, and 9642 for the same release version. We recommend that you update to the
latest Control Room build for the latest fixes.

IQ Bot On-Premises Control Room

Build 16685 Build 16685 (Automation 360 v.27)

Build 15450 Build 15459 (Automation 360 v.26)

Build 15112 Build 15112 (Automation 360 v.25)

Build 13343 Build 13343 (Automation 360 v.24R2)

Build 12350 Build 12350 (Automation 360 v.24)

Build 11513 Build 11513 (Automation 360 v.23)

Build 10520 Build 10526 (Automation 360 v.22)

Build 9642 Build 9664 (Automation 360 v.21)

Build 8815 Build 8815 (A2019.20)

Build 8098 Build 8147 (A2019.19)

Build 7554 Build 7560 (A2019.18)

Build 7082 Build 7103 (A2019.17)

Build 6443 Build 6463 (A2019.16)

Build 5931 Build 5933 (A2019.15)

Build 5322 Build 5322 (A2019.14)

Build 4695 Build 4705 (A2019.13)

Build 4088 Build 4105 (A2019.12)

Build 3337 Build 3337 (A2019.11)

Build 2545 Build 2545 (A2019.10)

Build 2079 Build 2079

Build 1610 Build 1610

Build 1089 Build 1089

Build 550 Build 550

Compatibilità della versione Automation 360 IQ Bot Cloud con Automation 360 Control Room:

IQ Bot Cloud Control Room

Build 16685 Build 16701 (Automation 360 v.27)
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IQ Bot Cloud Control Room

Build 15436 Build 15459 (Automation 360 v.26)

Build 14288 Build 14298 (Automation 360 v.25)

Build 12342 Build 12342 (Automation 360 v.24)

Compatibilità della migrazione con le versioni di IQ Bot precedenti

Consulta la seguente tabella di compatibilità delle versioni per vedere le opzioni di aggiornamento
disponibili per Automation 360 IQ Bot:

Versione IQ Bot Automation 360 IQ Bot (On-Premises)

Versione 11.3.5.x Sì

Versione 11.3.4.x Sì

Per eseguire la migrazione a Automation 360 IQ Bot On-Premises da una versione precedente alla 11.3.4.x,
eseguire prima l'aggiornamento a IQ Bot versione 11.3.4.x o successiva.
Migrazione a Automation 360 IQ Bot on page 1339
L'importazione di istanze di apprendimento tra versioni IQ Bot diverse non è supportata. Se si desidera
conservare i dati associati per un'istanza di apprendimento, assicurarsi di aggiornare o migrare alla
versione IQ Bot corretta prima di importare l'istanza di apprendimento corrispondente. Ad esempio, se
si esporta un'istanza di apprendimento in IQ Bot On-Premises (Build 8815), è possibile importarla solo
all'interno di una build IQ Bot On-Premises o Cloud equivalente.
Migrazione delle istanze di apprendimento on page 1347

Automation 360 software lifecycle policy
Automation Anywhere software lifecycle policy aims to make innovations and enhancements available to
you quickly. Through this policy, we provide you predictability, quality, and importantly nondisruptive access
to the latest innovations and enhancements so that you can control when and how you want to adopt
these enhancements.

Note:  The policies mentioned on this page apply to both Automation 360 Cloud and On-Premises
deployments unless where the differences are called out explicitly.

Panoramica

The software lifecycle policy helps you with change management while providing you the latest software
updates with enhancements in the Control Room, Bot Agent, and packages.
Our policy aims to provide faster access to features, bug fixes, and other enhancements for a better
customer experience:
• Predictability: With frequent, regular deployment cycles, you can get access to new and enhanced

packages sooner than before with predictable release cadence.
• Deploy new features: With control over introducing changes to your bots, you can test new features

and deploy them at your own pace.
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• Quality: With automated deployments from Automation 360 Cloud, you can use new packages that
include critical bug and security fixes.

• Nondisruptive access: You can update packages without disrupting your existing configurations.
• Backward compatibility: You now have the option to safely update bots while still having the option

to change back to a previous version of a package.

The following image shows the advantages of this lifecycle policy:

Aggiornamenti Bot Agent

When a new version of Bot Agent is available, by default, the Bot Agent is deployed automatically
across a customer's pool of devices without impacting existing bot functionality. However, Control Room
administrators can disable this default update capability and choose to update the Bot Agent manually. In
case of manual updates and in the event of a mandatory update, users will be notified that the Bot Agent
must be updated and all bot execution on these devices will stop until the Bot Agent is updated.
For larger deployments where device pools are deployed using standard device Amazon Machine Images
(AMI) on separate schedules, these updates will require coordination, change management processes, and
approvals in the customer environment. Therefore, Automation 360 will support backward-compatible Bot
Agent for a release every 6 months.
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Starting with Automation 360 v.24 release, 4 Bot Agent updates will be released each year with 2
optional and 2 updates that might be declared mandatory. You can skip the optional update and update
to the next mandatory Bot Agent update.
Our Q2 and Q4 releases will have optional Bot Agent updates and you can choose to skip the Bot Agent
update. However, the Q1 and Q3 updates might have mandatory Bot Agent updates. We will notify
customers 3 months in advance if a mandatory Bot Agent update is required with a Control Room release.

Aggiornamenti Package

Starting with Automation 360 v.24 release, delivery of packages is developed to be separate from the main
platform updates. This will help us respond quickly to changes and fixes required and provide the flexibility
to deliver updates in packages, going forward.
With this capability, new packages and new package versions can now be automatically downloaded from
Automation Anywhere Cloud when they are predictably released on a quarterly release cadence. These
downloaded packages become the default package so that customers can start using these package
versions on an ongoing basis as they become available.
This capability is enabled differently for Cloud and On-Premises Control Room instances, as listed in the
following table:

Seamless package update
capability

Cloud Control Room On-Premises Control Room

Download packages from
Automation Anywhere Cloud

Enabled by default and cannot
be disabled.

Disabled by default and can be
enabled.

Set downloaded package to
default version

Enabled by default and can be
disabled.

Enabled by default and can be
disabled.

• Utenti di Cloud: Automatic package download capability is now enabled across all Control Room
instances in all regions at the same time.
You can start using the latest packages on your current Control Room version before the Control Room
update is made available in your region.

• Utenti di On-Premises: This capability is disabled by default but it can be enabled by package
administrators.

We recommend that bot developers always use the latest version of the packages because that version
provides the latest innovations and all the code and security fixes from previous versions. However,
administrators can change this default behavior at any time and roll out the packages to developers after
verifying them. Queste nuove versioni del package sono anche retrocompatibili con la versione della
piattaforma esistente.
Note that this capability has no impact on existing bots, which continue to run unchanged. Bots that are
developed with a particular package version will always continue to do so unless explicitly changed by the
bot developer. This provides bot developers the flexibility to adopt new package versions when they are
ready for it. Bot developers must explicitly edit the bots in the Bot editor view and use the new package
version.

Support and deprecation policy for packages

Support and deprecation policy for packages aims to provide bot longevity and reduce overall maintenance
efforts to keep bots updated. The design consideration is to minimize the bot changes required to keep the
bot functioning.

© 2023 Automation Anywhere. All rights reserved.     744



    Automation Anywhere - Learn

Note:  This policy is in effect from Control Room release v.23.

Package versions supported for a minimum of
2 years

Package versions that are released will continue to
be supported for a minimum of 2 years after the
release. Even after 2 years, a package version will
continue to be supported unless it is deprecated.
Typically, a new version of the package will be
made available if a package is deprecated. All issues
and security fixes reported for the package will be
fixed in the latest version, with no backporting.
You will be notified 3 months in advance when a
package version is planned for deprecation. If there
is a critical security vulnerability, we will make the
best effort to send an advanced notification.

Packages version compatibility with Bot
Agent and Control Room

Package versions and bots that use these versions
will be compatible with all the Control Room and
Bot Agent versions released within the 2 years after
the package version release. Bots that use these
supported package versions do not have to be
configured to be compatible with the Control Room
and Bot Agent versions.

Deprecation policy on package version Package versions will not be depreciated within the
2 years after their release unless there is a critical
security vulnerability that has to fixed. In such a
case, a new package version will be made available
with the fix.

Minimal bot changes The package version support policy aim is to
minimize the effort required to change existing bots
and to keep them functioning.
Bots using a specific package version do not have
to be updated to use the package versions if the
existing package version is supported. However, we
recommend that you use the latest version of the
package when developing the bot to increase the
longevity of the bot. The package versions used
in a bot will have to be updated before they are
deprecated for the bot to remain supported.

Bot lifecycle

The design assumption for bots is that the version of the package used in the bots is present in the Control
Room that is used to run the bots. Before developers promote bots, we recommend that the developers
verify that the package version used in the bots matches the package version in the higher environments.
When promoting bots to higher environments (for example, testing and production) that are on a lower
software version, ensure that you include the dependent packages for bots. This will ensure that the target
environment has all the package versions required by the bot.
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Note:  Some package versions will not be backward compatible with an earlier version of the Control
Room or Bot Agent. Therefore, refrain from using such incompatible package versions during the Control
Room environment update phase.

See also: Automatic package updates for On-Premises Control Room.
Related concepts
Feature deprecations affecting Automation Anywhere products on page 759
Review the features and capabilities (from Automation Anywhere or third party) that are deprecated or
nearing deprecation to understand how they affect your automation and what action is required.
Related reference
Automation 360 Cloud FAQ on page 54
Answers to frequently asked questions (FAQ) and related information provide insight into various aspects
related to Automation 360 Cloud.
Automation 360 Cloud updates on page 756
Automation 360 Cloud is a multitenant cloud service that leverages the latest best practices in delivering
web-scale SaaS to rolling out incremental updates globally using a continuous deployment pipeline.

Automation 360 Cloud for secure access and connectivity
You can develop and run bots securely using the Automation 360 Cloud access security.

High-level architecture of Cloud deployment

The following information provides a high-level workflow of the Automation 360 Cloud deployment:
1. Using a browser, you log into the Control Room and create users and roles. You perform this process

on the Automation 360 Cloud.
2. You install the Bot Agent on your Windows device to run bots locally. You perform this process on your

infrastructure.
3. Data flow between the Automation 360 Cloud and the Bot Agent on your Windows device on your

infrastructure is encrypted using TLS 1.2 (outbound port 443 only).

The following image shows the Automation 360 Cloud architecture:
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Identity and Access Management (IAM) security for user system

• When an admin user logs into the Automation 360 Control Room for the first time, the admin can
configure SAML 2.0 to connect the Automation 360 Cloud Control Room to their own Identity Provider
(IdP) so that their users can log in to the Control Room using MFA (multi-factor authentication).

• The admin can then create the required users and roles or permissions to perform certain activities
(such as developing and running bots) in the Control Room.

• The Automation 360 Control Room users can then log in through MFA and start creating and running
bots.

• Additionally, the admin can configure an allowed IP address range to manage user logins through the
Administrator settings in the Control Room.

To learn more about Automation 360 Cloud, see Introduzione a Automation 360 Cloud on page 827.

Secure connectivity to run bots

You run bots locally on a Windows machine on which the Bot Agent is deployed. You can download and
install the Bot Agent on your devices or deploy to a pool of virtual machines.
Before you install the Bot Agent, the following criteria must be met:
• The integrity of the device on which the Bot Agent is installed is not compromised.
• The user organization has instituted security safeguards and controls to prevent Bot Agent takeover and

system-level user breaches.
• The user environment is safe from network-based attacks such as Domain Name System (DNS) cache

poisoning, Address Resolution Protocol (ARP) spoofing, and so on.

Note:  Automation 360 Cloud includes security operation controls to check for man in the middle (MITM)
attacks and malicious intercepts.

Bot Agent installation and registration When you register your device, the Bot Agent
device is provided a JSON Web Token (JWT) to start
the registration process with the Control Room. If
the token provided by the Bot Agent device does
not match the token provided by the Control Room,
the registration process will fail. This authenticates
the client Bot Agent device to the Control Room.
In the bulk installation and registration mode of
the Bot Agent, the Bot Agent device comes online
preregistered with the Control Room URL specified
in the autoregistration.properties file.
When using the bulk registration settings, one
cannot enter or specify a fake Control Room URL
without administrator privileges on that device.
When the Bot Agent starts for the first time, it
will read the autoregistration.properties
file and register itself to the Control Room URL
specified in the properties file. By default, the
option to switch the Bot Agent registration from
one Control Room to another is disabled. Only
the Control Room administrators can enabled this
option. If someone tries to register another URL
when this option is disabled, the registration would
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fail immediately and generate an error mentioning
that says Control Room is already registered and
switching of the Control Room URL is not allowed.
By providing write access to a cache folder for the
admin only and read permissions to all other users
who can run bots, we can assure that when a bot
is downloaded to the device cache, it cannot be
manipulated to perform potentially harmful things.

Communication between Bot Agent and
Control Room

The Bot Agent device establishes a websocket
connection to the Control Room using HTTPS
(outbound port 443) and no inbound connection is
required.
• Server authentication: The Transport Layer

Security (TLS) handshake ensures that the
Common Name (CN) in the server certificate
issued by the well-known certification authority
(CA) matches the legitimate hostname as
included in the certificate chain of trust.

• Client authentication: After registration, a
valid token key is always required from the Bot
Agent to establish a connection to the Control
Room. The token is encrypted using the Bot
Agent private key and can only be decrypted by
using the Bot Agent public key that was used
when the Bot Agent device was registered to
the Control Room. The token also authenticates
the Bot Agent device every time the Bot Agent
connects to the Control Room.

Data connection between a customer's network
and the Cloud service is protected with a strong
TLS connection that leverages at least 2048-bit RSA
server certificates, 128-bit symmetric encryption
keys, and stronger TLS protocols. This secure
connection makes it virtually impossible to breach
the established TLS connection.
After the websocket connection is established, the
communication between a customer's network
and the Cloud service is secured and bidirectional.
The connection between the Bot Agent device and
the Automation 360 Cloud hosted Control Room
is permanent and automatically reestablished if
connectivity is lost. This connection is used to
download the bots to run and send operational
status information to the Control Room.

Note:  The connectivity is established only one
time and not for each bot.

Schedule bots to run Control Room users can schedule bots to run.
Compiled bots are downloaded to run on the Bot
Agent devices and operational logs are sent from
the Bot Agent devices to the Control Room.
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For the bots to run, the Bot Agent establishes an
active Windows session by authenticating as the
licensed Bot Runner user on the Bot Agent device.

Secure credentials for bots Bots that run on the Bot Agent devices need to log
in to the device using credentials. You can store
credentials securely in the Automation 360 Cloud
Control Room credential vault. Alternatively, you
can store credentials in a customer-hosted key
management system (for example, CyberArk).
When you store credentials in the customer-
hosted key management system, you must have
connectivity between the Control Room and the
customer's key management system. To provide
connectivity and allow access, you must configure
the Automation 360 Cloud IP addresses for the
specific Automation 360 Cloud region that is hosting
the Control Room in their firewall. Per ulteriori
informazioni, consulta Automation 360 IP addresses
for external integrations on page 2757.

Secure operations in Automation 360 Cloud

Automation 360 Cloud is run securely and meets compliance standards for: SOC 1, SOC 2, ISO 27001, and
HITRUST.
• For information about Automation 360 Cloud deployment and operational models, see Automation 360

Cloud Security and Data Privacy.
• For Automation 360 Cloud compliance reports, see Security and Compliance Portal.

Automation 360 Cloud Service Status site
The Automation 360 Cloud Service Status site displays real-time operational status, historical operational
status, maintenance information, and incident history for all Automation 360 Cloud services worldwide,
across all hosting regions.
Automation 360 Cloud Service Status site

How you can use the site

You can use the Automation 360 Cloud Service Status site to view various updates:

Note:  In addition to viewing updates, you can also receive updates regarding ongoing incidents and
upcoming scheduled maintenance by email or RSS feed by using the Subscribe option on the top-right
corner.

• Use the Component Summary section to view the real-time operational status of all the Cloud
services hosted from all regions worldwide.

• Use the Component Status History section to view the historical operational status of all Automation
360 Cloud services hosted across all regions worldwide.

Note:  This historical information can be traced back for a maximum of three months.
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• Use the Upcoming Maintenance - Next 14 days section to view maintenance information about
ongoing and upcoming incidents for the next 14 days.

• Use the Incident History section to view information about incidents that are resolved and scheduled
maintenance events that are completed .

Note:  In the Automation 360 Cloud Service Status site and in this documentation, the term "component"
refers to the Automation Anywhere service within a hosting region.

Real-time operational status

Automation Anywhere frequently monitors the accessibility and health of components from various
geographical regions across the world to report on the operational statuses of components in real time.
The Component Summary section provides a real-time view of the operational status of various
components.
The following table provides a list of operational statuses along with definitions and examples:

Component statuses along with definitions and examples

Component status Definizione Esempio

Operational All the services in the region are
operational and available.

All the Control Room URLs are
accessible, and customers can
log in to their Control Room
instances.

Informational All the services in the region are
operational but have an incident
that does not affect customers.

Under Maintenance The services in the region are
currently unavailable.

The service is undergoing a
planned maintenance event.

Degraded Performance There is an incident that affects
performance significantly.

• The service is available, but
one or more capabilities
of the service are not
performing optimally.

• Services in the region are
occasionally inaccessible or
interrupted.

• Bots in the region
occasionally fail for some
customers.
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Component status Definizione Esempio

Partial Outage There is a major incident
that affects a few customers
significantly.

• Services in the region
are inaccessible, or some
customers (more than 25
percent of customers in the
region) cannot log in to their
Control Room instances.

• Bots in the region fail for
some customers.

• A security or data breach
has occurred for some
customers in the region.

Major Outage There is a critical incident with
very high impact across the
region.

• Services in the region are
inaccessible, and customers
cannot log in to their Control
Room instances.

• Bots fail to run successfully
on the Control Room
instances in the region.

• A security or data breach
has occurred for all the
customers in the region.

• A Cloud region has
completely failed, triggering
a disaster recovery event.

Historical operational status

The Component Status History section provides a historical view of the availability status of all the
components over the preceding seven days. You can use the Search Components option at the top-left
corner of the section to search for the historical operational status of a specific component. You can use
the arrows on the top-right corner of the section to view the historical operational status of components,
one week at a time, for the preceding three months.
This section also provides an aggregated incident status for all the incidents for any given day. Click the
days with incidents to view a summary of uptime details along with a list of incidents reported for that day.

Note:  Planned maintenance windows are reported as incidents.

Maintenance information

Two types of incidents are monitored for and reported on the Automation 360 Cloud Service Status site:
• Planned incidents: Incidents that are primarily related to planned maintenance windows for software

updates, such as patch updates, security updates, and infrastructure updates.
• Unplanned incidents: Unplanned interruptions that result in reduced or degraded service

performance or total interruption to service availability for some or all customers.

Planned maintenance events
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The planned maintenance window is published well in advance of scheduled events and is conducted to
improve multiple aspects of a service. A planned maintenance event is scheduled to deploy a software
update, a patch to fix an existing issue, a security patch to resolve a security vulnerability, or an
infrastructure component update to improve the reliability, resiliency, and availability of the service. Users
who are subscribed to incident notifications receive an email notification about the details of maintenance
windows.
Planned maintenance events typically last for four to six hours per geographical region when updates are
rolled out. Although the actual downtime during the update varies, completion is typically within 10 to15
minutes. If IQ Bot is in use, completion time is typically 20 to 30 minutes.
The Automation 360 Cloud Service Status site provides information about the following types of planned
maintenance events:

Planned maintenance event for deploying
Automation 360 release update

This planned maintenance event deploys new
Automation 360 software release update to the
Automation 360 Cloud. Here are the notification
fields for this software release update:

Titolo Planned upgrade for
Automation 360 Cloud
for a region

Descrizione Planned upgrade for
Automation 360 to
the Automation 360
Cloud, which results in
minor interruptions to
the service during this
period.

Note:  We recommend
that you do not run bots
during this period.

Advance Notice The notification
announcing this
maintenance window is
published at least two
weeks in advance on the
Automation 360 Service
Status site. The release
notes are published in
advance of the update.

Planned maintenance event for deploying
patch (non-security) release for Control
Room

This planned maintenance event deploys
Automation 360 software patches to Automation
360 Cloudto fix existing or unknown issues. Here
are the notification fields for this patch release
update:

Titolo Emergency patch for
Automation 360 Cloud
for a region

Descrizione This is a critical, non-
security patch upgrade
for Automation 360 to
the Automation 360
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Cloud, which results in
minor interruptions to
the service during this
period.

Note:  We recommend
that you do not run bots
during this period.

Advance Notice The notification
announcing this
maintenance window
is published with best
effort, in advance, on
the Automation 360
Service Status site.
The release notes are
published in advance of
the update.

Planned maintenance event for deploying
patch (security) release for Control Room

This planned maintenance event deploys
Automation 360 security fixes to Automation 360
Cloud to fix existing vulnerabilities, known security
issues, and Cloud component updates to resolve
vulnerabilities. Here are the notification fields for
this update:

Titolo Emergency security
patch for a region

Descrizione This is a critical security
patch upgrade for
Automation 360 to
the Automation 360
Cloud, which results in
minor interruptions to
the service during this
period.

Note:  We recommend
that you do not run bots
during this period.

Advance Notice The notification
announcing this
maintenance window
is published with best
effort, in advance, on
the Automation 360
Service Status site
depending on how
critical the security issue
is. The release notes are
published in advance of
the update.
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Planned maintenance event for Automation
360 infrastructure updates

This planned maintenance event deploys updates
related to the Automation 360 Cloud infrastructure.
Here are the notification fields for this update:

Titolo Planned infrastructure
upgrade for Automation
360Cloud for a region

Descrizione This is a planned
infrastructure upgrade
for Automation 360
Cloud, which results in
minor interruptions to
the service during this
period.

Note:  We recommend
that you do not run bots
during this period.

Advance Notice The notification
announcing this
maintenance window is
published at least two
weeks in advance on the
Automation 360 Service
Status site. The release
notes are published in
advance of the update.

Planned maintenance event for patch
(security) release for IQ Bot Hybrid Titolo Planned upgrade for

Automation 360 Cloud
for IQ Bot Cloud servers
for a region

Descrizione This is a critical patch
update for IQ Bot on
the Automation 360
Cloud, which results in
interruptions to the IQ
Bot service during this
period. Access to the
main Automation 360
Cloud Control Room and
other services are not
affected.

Note:  We recommend
that you do not
schedule bots that use
IQ Bot capabilities to
start during this period.

Advance Notice The notification
announcing this
maintenance window is
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published at least two
weeks in advance on the
Automation 360 Service
Status site. The release
notes are published in
advance of the update.

Incident history

The Incident History section shows a detailed list of resolved incidents and completed scheduled
maintenance events for the preceding seven days.
The list includes the following details about each incident:
• Incident description
• Incident duration (start time, end time, and duration of the outage)
• Affected components
• Incident status updates
• Information in cases of unplanned service outages

Automation 360 Cloud updates
Automation 360 Cloud is a multitenant cloud service that leverages the latest best practices in delivering
web-scale SaaS to rolling out incremental updates globally using a continuous deployment pipeline.
Automation 360 Cloud provides updates to the Bot Agent instances running on your infrastructure. The
Bot Agent is a lightweight, Java-based, modular application that handles particular bots and their packages
when they are scheduled to run.
Bot Agent updates are transparent to active Bot Creator users. For operations, the Bot Agent updates
are carried out automatically, by default, without requiring administrative privileges (much like browser
updates).

Note:  This is regardless of whether the Bot Agent was installed as a system user or local user.

With each update, products such as RPA Workspace, Control Room, IQ Bot, Bot Insight, Discovery Bot,
and AARI have improved security and enhanced features. Application command packages can also be
enhanced and made available for inclusion into bots on your release cycle.
Updates are rolled out over a 3-hour maintenance window per geographical region. These maintenance
windows are posted on the Automation 360 Cloud Service Status site. Although the actual downtime
during the update varies, completion is typically within 10-15 minutes. If IQ Bot is in use, completion time
is typically 20 - 30 minutes. In general, bots run to completion during updates, with the following scenarios
being exceptions:
• The bot tags data for Bot Insight.
• Bots that run WLM.
• Credentials directly entered as command input are pulled from the Control Room at execution time.

Instead, use credential type variables.
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• Child bots: Parent/child bots run to completion because the child bots are downloaded when the parent
bot starts its run.
Exceptions:
• If a child bot is referenced using a variable parameter because the child bot requires the Control

Room to be available when the parent bot runs.
• If a child bot does not use the same global variables as the parent bot.
• If a child bot is using credential type variables.

After the Bot Agent has reconnected to the Control Room, the bot status is updated in the bot run activity
logs.
Automated Bot Agent update takes place after an agent completes any current bot run and the Bot Agent
reconnects to the Control Room.
During this short downtime, any bots scheduled to run will not be run. It is therefore recommended that
bots are not scheduled to start to run during the planned maintenance window.
The following table provides a list of regions and the day and time of their maintenance windows. The
upgrade occurs sequentially over a three week period:
• Week 1 - First rollout will begins in the AP-AUS and AP-Sing regions
• Week 2 - Second rollout begins in the EU-West1, EU-West4, LATAM, ME, S, Africa, US-East, US-Central,

and India regions
• Week 3 - Third and final rollout begins in the US-West, Canada, and Japan

Important:
Times mentioned below are in UTC (Coordinated Universal Time). To convert to your local time, refer to a
universally recognized online resource such as https://www.worldtimezone.com/.

Regione Day and time in UTC

AP-AUS Wednesday, 12:00 to 15:00

AP-Sing Wednesday, 16:00 to 19:00

EU-West1 Tuesday, 20:00 to 23:00

Europa occidentale4 Tuesday, 20:00 to 23:00

LATAM Thursday, 02:00 to 05:00

ME Thursday, 20:00 to 23:00

S. Africa Thursday, 20:00 to 23:00

US-East Friday, 02:00 to 05:00

US-Central Friday, 02:00 to 05:00

India Friday, 20:00 to 23:00

US-West Monday, 02:00 to 05:00

Canada Monday, 02:00 to 05:00

Giappone Monday, 16:00 to 19:00
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Note:  A small interim update might be planned to address urgent, priority updates mid-cycle between
the primary quarterly updates. These will occur on the same day of the week and time as the schedule
mentioned previously.

Regular updates

Regular updates are planned approximately every 3 months and are scheduled to occur during non-
business hours and not close to the beginning or end of a month. Notifications are posted to the Service
Status site 2 weeks in advance of the update. A notification message is also pushed to administrators in
the Control Room in advance.
You can review changes in the release notes that are made available 3 weeks before each update.

Note:  As a customer, you can use a sandbox Control Room environment to try out the next update at
least 3 weeks before the main Dev/UAT/Prod environments are updated.

Command packages might be updated and made the default for creating new bots. Existing bots continue
to use their existing package versions. New bots use the new default package version. However, as a user,
you can also choose to revert to the previous version.

Cloud infrastructure updates

Cloud infrastructure updates are carried out typically once every 3-month period. If these infrastructure
updates involve planned downtime for Automation 360 Cloud, notifications are posted on the Service
Status site at least 1 week in advance.

Critical patch updates

Patch updates might be required for either critical security updates or where serious issues with an update
affect the majority of Cloud customers.
Patches require a maintenance window although they typically do not require a Bot Agent update. For
patch updates, advance notice will be provided on the Service Status site.

Planned maintenance windows

Automation Anywhere offers planned update maintenance windows to enable customer operations to
support Bot Lifecycle Management. Outside of planned maintenance windows for the updates mentioned
previously, the Automation 360 Cloud availability SLA is 99.9 percent per month.

Note:  Per ulteriori informazioni, consulta Cloud Automation Agreement.

The following table provides information such as frequency, time expectation, and client action for different
types of updates:

Type of update Frequenza Time expectation Client action

Regular Automation
360 Control Room and
Bot Agent

3 - 4 months 3-hour window
Around 10 minutes of
downtime

Bots can run to
completion. Do not
schedule bots to start
during this 3-hour
window.
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Type of update Frequenza Time expectation Client action

Sandbox At least 3 weeks
prior to regular Cloud
updates

Try new features out
after the window.
Sanity-test production
bots.

Cloud infrastructure Once every 3-month
period

Varies. Scheduled on
weekends.

Bots can run to
completion. Do not
schedule bots to start
during the window.

Critical patch As needed Critical notice given

Subscribing to notifications
In the Automation 360 Cloud Service Status site, subscribe to email notifications about planned
maintenance events and unplanned incidents that affect service availability.
To subscribe to email notifications from the Automation 360 Cloud Service Status site about planned
maintenance events and unplanned incidents that affect service availability, click Subscribe on the top-
right corner of the Service Status site.
Provide your name and email address when subscribing to notifications.
You can manage your subscription by clicking Manage Existing Subscription. The system sends you
a link, by email, with which you can manage your incident notification subscription. You can select the
service and the region for which you want to receive status notifications.
To subscribe to incident notifications for the Cloud region where your services are hosted, open an
Automation Anywhere support ticket.

Personalizing the Service Status site

You can personalize the Automation 360 Cloud Service Status site by selecting the language and time zone
of your choice for showing incidents. To select language and time zone, click the gear icon on the top-right
corner.

Lingua You can select a language from among seven
supported languages.

Fuso orario When you select a time zone, the incidents from the
selected time zone will be shown.

Feature deprecations affecting Automation Anywhere products
Review the features and capabilities (from Automation Anywhere or third party) that are deprecated or
nearing deprecation to understand how they affect your automation and what action is required.

Definition:  Deprecation refers to features or capabilities available in the current (latest) release that are
planned to be removed or unsupported in a future release.
You can use the specified alternatives or updated versions when they are made available.
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Third-party feature deprecations

Upcoming: The following table lists third-party features that will be deprecated by the date mentioned:

Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

EWS API
See Upcoming API
Deprecations in
Exchange Web Services
for Exchange Online

Ongoing
deprecation

Automation 360 currently uses
EWS API in Email package and
Email trigger for the EWS option to
connect to Exchange Online hosted
on Azure Cloud and access emails
from Microsoft 365.
Microsoft has recommended that
customers move to a REST-based
Graph API, which is more secure and
scalable compared with the legacy
SOAP-based EWS API. Therefore
Automation 360 will provide support
for Microsoft 365 Outlook package
based on Graph APIs which will
enable you to switch from EWS API
to Graph API from an upcoming
release.
This deprecation by Microsoft might
impact bots for email automations
(Email package and Email trigger)
that connect to Exchange Online
using EWS API. Note that there
is no immediate impact on your
existing bots and they continue to
run properly.
Recommended: Update the
impacted bots by replacing each
email-related action with the
equivalent new actions in the
Microsoft 365 Outlook package,
planned in the upcoming release
if your bots are impacted by the
deprecation.

--
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Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

Transport Layer
Security (TLS) 1.0
and TLS 1.1

April 2023 Automation 360 Cloud deployments
currently support the following TLS
protocol versions:
• TLS 1.0
• TLS 1.1
• TLS 1.2
• TLS 1.3

However, the TLS 1.0 and TLS 1.1
protocol versions have security
vulnerabilities as per the industry
security standards. Therefore,
Automation 360 Cloud deployments
for Amazon Web Services and Google
Cloud Project will support only
the TLS 1.2 and TLS 1.3 protocol
versions.

Note:  For Automation 360 Cloud
deployments, the changes will
be effective as part of the Cloud
deployment configurations, not as
part of the Automation 360 release.

Deprecating TLS 1.0
and TLS 1.1
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Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

Manifest V2 based
extensions by Google
See also: Overview
and timelines for
migrating to Manifest
V3

January 2023 Automations that use Google Chrome
Manifest V2 based extensions will
stop working sometime after June
2023. The deprecation timelines of
Manifest V2 based extensions are
currently under review and subject to
change by Google.
• For Google Chrome Manifest V2

extensions timelines, see Manifest
V2 support timeline.

• For Microsoft Edge Manifest V2
extensions timelines, see Overview
and timelines for migrating to
Manifest V3.

This might impact customer bots
that automate web applications over
Google Chrome and Microsoft Edge.
Recommended: Switch to Manifest
V3 based extensions for Google
Chrome and Microsoft Edge.
Releases:
• Automation 360 v.26
• Version 11.3.5.8

• Chrome and
Edge Manifest V3
extensions on page
807

• Enterprise 11:
Deprecation of
Basic authentication
and MV2 extensions

• Version 11.3.5.8
Release Notes

Completed: The following table lists third-party features that are already deprecated:

Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

Basic authentication in
Exchange Online

October 2022 Bots for email automations (Email
package and trigger) that connect
to Exchange Online by using IMAP,
POP3, or EWS protocols with Basic
authentication will be impacted.
Recommended: Update the
impacted bots by replacing each
email-related action with OAuth 2.0.
Released:
• A package only release for

Automation 360 v.25
• Version 11.3.5.7 client patch

• Deprecation of
Basic authentication
in Exchange Online
on page 792

• Enterprise 11:
Deprecation of
Basic authentication
and MV2 extensions
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Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

Internet Explorer EOL June 2022 Customers who are running IE-based
bots on Windows 10 Semi-Annual
Channel are impacted.
Releases with tools to convert IE-
based bots to Microsoft Edge with IE
mode:
• Automation 360 v.24R2
• Version 11.3.5.6

Microsoft Internet
Explorer EOL
overview on page
766
Microsoft Internet
Explorer 11 EOL
FAQ on page
770

Automation Anywhere feature deprecations

Upcoming: The following table lists Automation Anywhere features that will be deprecated by the date
mentioned:

Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

V2 Repository Files
List API

June 2023 From Automation 360 v.29, the
Repository Files List API (v2/
repository/file/list) will be
deprecated.
Recommended: You can use the
/v2/repository/workspaces/
{workspaceType}/files/list

Deprecated API: v2/
repository/file/
list

Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

Descoped language
support

June/July
2023

Beginning with Automation 360 v.29,
the User Interface for Automation
Anywhere product will no longer
support Italian, Russian, and
Simplified Chinese languages.
In addition, updated release
documentation will no longer be
available in these three languages
though older documentation will be
accessible.

--

Completed: The following table lists Automation Anywhere features that are already deprecated:
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Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

IQ Bot Extraction
package

October 2022 From Automation 360 v.25, the IQ
Bot Extraction package no longer
supports pretrained machine learning
model for invoice data extraction
but will continue to support learning
instance group based-training
extraction.
Recommended: Use the new
command package called Document
Extraction, released in v.25 as part of
Document Automation.
Released: Automation 360 v.25

Move from IQ Bot
Extraction package to
Document Automation
on page 1657

IQ Bot - Tesseract
OCR v3

October 2022 For all existing learning instances
trained using Tesseract OCR v3,
we recommend that you plan to
train them with alternative OCRs
(including Tesseract4 OCR) before
you update to v.26. Note that
Automation 360 IQ Bot Cloud
customers will receive the v.26
release by default from October
2022.
Released: Automation 360 v.26

--

G-Suite Apps September
2022

From Automation 360 v.26, the
GSuite Apps package no longer
supports using the Connect and
Disconnect actions to establish a
connection with the Google server
and automate tasks.
Recommended:For specific G-Suite
applications, the functionality of the
G-Suite Apps package is available in
the following G-Suite packages:
• Google Drive
• Google Calendar
• Google Sheets

To automate tasks, in the
appropriate G-suite package, use
the corresponding Connect and
Disconnect actions.

Utilizzo dell'azione
Connetti per i pacchetti
Google on page 1600
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Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

Human-Bot
Collaboration 11.3.x

August 2020 Human-Bot Collaboration (HBC)
11.3.x was deprecated from August
2020 with the release of Enterprise
A2019.15.
Recommended: Migrate to
Automation 360 to use the
Automation Anywhere Robotic
Interface (AARI) that includes
Desktop and Web.

Note:  For this migration, there is no
automated migration path between
HBC 11.3.x and AARI because of an
absence of parity between the two
products (including sets of features).

New: Automation
Anywhere Robotic
Interface (AARI) on
page 2106
Deprecated: :

Automation
Anywhere Mobile app

July 2022 The Automation Anywhere Mobile
app is deprecated and will not be
updated to subsequent versions
of iOS and Android. The mobile
app is no longer available and no
further support will be offered. A
replacement product is currently not
available.

Archived
Documentation
(PDF): EN-US

V2 Activity List API June 2022 From Automation 360 v.25, the
Activity List API (v2/activity/
list) is deprecated.
Recommended: With the newly
implemented Activity List API (v3/
activity/list), you can return
the job executions without call back
and bot output information.

Note:  If you want to get
the botOutVariables or
callbackInfo, use /v3/
activity/execution/{id} Bot
Execution Orchestrator API .

New API:
Activity List v3/
activity/
listBot Execution
Orchestrator API
Deprecated API:
v2/activity/
list
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Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

RPA Bots for Excel January 2022 RPA Bots for Excel has been
deprecated. The plug-in is no longer
available to download as a product.
However, support will be offered to
current customers already using the
product.
A replacement product as a plug-in
for Microsoft Excel is not available.
However, as an alternative, new
customers can develop bots for
Excel within the Automation 360
RPA Workspace and use input
variables to allow specifying file
names, worksheets, and ranges for
bots to operate on. In RPA Bots for
Excel, this action was triggered from
within the Excel application, whereas
now, this action is taken from the
Automation Anywhere Control Room.

Documentation:
Archived docs for RPA
Bots for Excel v2.0

See also: Automation 360 software lifecycle policy on page 742
Related concepts
Automation 360 software lifecycle policy on page 742
Automation Anywhere software lifecycle policy aims to make innovations and enhancements available to
you quickly. Through this policy, we provide you predictability, quality, and importantly nondisruptive access
to the latest innovations and enhancements so that you can control when and how you want to adopt
these enhancements.
Deprecation of Basic authentication in Exchange Online on page 792
Microsoft will permanently disable Basic authentication for specific protocols in Exchange Online starting
from October 1, 2022. This impacts customers running bot for email automation that connect to Exchange
Online using IMAP, POP3, or EWS protocols with Basic authentication.
Chrome and Edge Manifest V3 extensions on page 807
As Google will deprecate Manifest V2 extensions , this might impact your existing automations that use
the current Manifest V2 extensions for Google Chrome and Microsoft Edge browsers. We have published
Manifest V3 extensions with the Automation 360 v.26 release to help you start switching to Manifest V3
extensions.
Microsoft Internet Explorer EOL overview on page 766
Microsoft has announced retiring Internet Explorer (IE) for certain versions of Windows operating systems
and recommends impacted users to move their apps or websites running on IE to Microsoft Edge with IE
mode.

Microsoft Internet Explorer EOL overview
Microsoft has announced retiring Internet Explorer (IE) for certain versions of Windows operating systems
and recommends impacted users to move their apps or websites running on IE to Microsoft Edge with IE
mode.
While support for the Control Room (Automation 360 v.25) on IE will end, new and advanced features will
be added to Automation 360 v.24R2 patch that will be supported on alternative browsers.
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To ensure your existing IE bots are supported on Microsoft recommended browsers, such as Microsoft
Edge with IE mode, based on the release you have installed, we recommend that you update to
Automation 360 v.24R2 patch. To support conversion of IE bots to Microsoft Edge with IE mode, the
following tools are available in this patch:
• Bot Scanner to scan Enterprise 11 bots for IE usage. This helps you to plan your efforts in the IE bot

conversion process whether you continue on Enterprise 11 or migrate to Automation 360.
Panoramica di Bot Scanner on page 1158 | Scan Enterprise 11 or 10 bots using Bot Scanner on page 1160

• Bot Migration Wizard to support conversion of IE bots to Microsoft Edge with IE mode. This will help
Enterprise 10 or Enterprise 11 users to migrate bots to Automation 360 and convert the IE bots at the
same time.
Bot Migration Wizard on page 1213

• Update Bot wizard to help Automation 360 new users as users who have migrated from Enterprise 10
or Enterprise 11 and want to convert their IE bots to Microsoft Edge with IE mode.
Update Bot wizard for converting IE bots on page 786

See the following video on preparing your automations for IE EOL:

Update scenarios

• If you are using Enterprise 10, to update your IE bots to Microsoft Edge with IE mode, you can
choose one of the following methods:
• Upgrade to Automation Anywhere Enterprise Version 11.3.5.6 that supports IE bot conversion to

Microsoft Edgewith IE mode, convert your IE bots to Microsoft Edge with IE mode, and later migrate
to the latest Automation 360 release.

• Upgrade to Automation 360 v.24R2 patch, migrate your IE bots and update the IE bots to Microsoft
Edge with IE mode.

• If you are using Enterprise 11 and are yet to migrate to Automation 360, update to Automation
Anywhere Enterprise Version 11.3.5.6, which supports Microsoft Edge with IE mode. You can then
migrate to Automation 360.
Versioni Control Room supportate per la migrazione on page 1136

• If you are using Enterprise 11 and plan to complete migration to Automation 360 before IE EOL, you
can migrate to the latest Automation 360 v.24R2 patch, which supports Microsoft Edge with IE mode.

• If you are using Enterprise 11 and plan to complete migration to Automation 360 after IE EOL, you can
use one of the following methods:
• Update to the latest Automation 360 release, convert the migrated bots created in IE to Microsoft

Edge with IE mode.
• Update to the latest Enterprise Client version that supports Microsoft Edge with IE mode and convert

the pending bots created in IE to Microsoft Edge with IE mode in Enterprise 11, and later migrate
these bots to the latest Automation 360 release.

• If you are using Automation 360 v.24 On-Premises or earlier and have created IE bots, you can update
to Automation 360 v.24R2 patch to convert your IE bots to Microsoft Edge with IE mode.

Note:  To ensure that your bots continue to run on Internet Explorer after EOL, Microsoft recommends
that you register your site or application running on Internet Explorer to the Microsoft Site List manager.
Consulta Enterprise Mode and the Enterprise Mode Site List.

For additional information on different upgrade scenarios, see Enterprise 11 and upcoming Internet Explorer
11 EOL FAQ | Microsoft Internet Explorer 11 EOL FAQ on page 770
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IE bot update workflow

Update from Automation 360 to Automation
360 On-Premises

1. Update to the latest Automation 360 release.
Aggiornamento alla versione di Automation 360 più
recente on page 1063

2. Set up Automation 360 Bot Runners for bot
updates.
Installazione di Bot Agent e registrazione del
dispositivo on page 1039

3. Back up the Control Room repository.
Ripristino di bots da archivio Git on page 2761

4. Identify bots created in Internet Explorer using
the Bot Scanner.
Scan Enterprise 11 or 10 bots using Bot Scanner on
page 1160

5. Convert the bots created in IE to Microsoft
Edge with IE mode using the Update Bot
wizard.
Update Bot wizard for converting IE bots on page
786

6. Analyze the updated bots report using the
Update Bot wizard.
Viewing conversion details for Internet Explorer
bots on page 789

7. Verify that the updated bots can run or be
deployed.
Programmare un bot on page 2616 | Run a bot
on page 1994

Important:  Before you deploy your bots,
register your site or application running on
Internet Explorer to the Microsoft Site List
manager. Per informazioni, consulta Enterprise
Mode and the Enterprise Mode Site List.

Note that you can convert your IE bots
to Microsoft Edge with IE mode in one
environment (for example, DEV) and then
move these bots to another environment (for
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example, UAT and PROD) without updating the
bots in each environment.

Upgrade from Enterprise 11 to latest
Automation 360 On-Premises

1. Upgrade from Enterprise 11 to the latest
Automation 360 release that supports Microsoft
Edge with IE mode.
Preparazione per la migrazione Enterprise 11 a
Automation 360 On-Premises on page 1189

2. Set up Automation 360 Bot Runners for bot
updates.
Installazione di Bot Agent e registrazione del
dispositivo on page 1039

3. Back up the Control Room repository.
Ripristino di bots da archivio Git on page 2761

4. Identify the bots created in Internet Explorer
using the Bot Scanner.
Scan Enterprise 11 or 10 bots using Bot Scanner on
page 1160

5. Migrate Bot Runners and IE bots from
Enterprise 11 to Automation 360.
Bot Migration Wizard on page 1213

6. View the bot migration report.
Visualizza i rapporti di migrazione on page 1299

7. Verify that the migrated bots can run or be
deployed.
Programmare un bot on page 2616 | Run a bot
on page 1994

Related concepts
Microsoft Internet Explorer 11 EOL FAQ on page 770
Microsoft has announced end-of-life (EOL) for Internet Explorer beginning June 2022 and recommends
using Microsoft Edge or Microsoft Edge in Internet Explorer (IE) mode. Ciò influirà sulle automazioni (bots)
a seconda del sistema operativo in cui sono eseguiti i bots.
Microsoft Internet Explorer 11 EOL FAQ on page 770
Microsoft has announced end-of-life (EOL) for Internet Explorer beginning June 2022 and recommends
using Microsoft Edge or Microsoft Edge in Internet Explorer (IE) mode. Ciò influirà sulle automazioni (bots)
a seconda del sistema operativo in cui sono eseguiti i bots.
Related reference
Note sulla versione di v.24R2 Automation 360 per EOL Internet Explorer 11 on page 259
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Related information
Enterprise 11 and upcoming Internet Explorer 11 EOL FAQ

Microsoft Internet Explorer 11 EOL FAQ
Microsoft has announced end-of-life (EOL) for Internet Explorer beginning June 2022 and recommends
using Microsoft Edge or Microsoft Edge in Internet Explorer (IE) mode. Ciò influirà sulle automazioni (bots)
a seconda del sistema operativo in cui sono eseguiti i bots.
Per i dettagli, consulta la tabella di seguito:

Sistema operativo Microsoft Automation 360 e Enterprise 11 bots

Canale semestrale di Windows 10 Update bots to use a compatible browser.
Per un elenco dei browser supportati, consulta
Requisiti del browser per RPA Workspace on page
866.

Tutti gli altri sistemi operativi supportati Nessun effetto immediato

A partire da Automation 360 v.25, ti verrà chiesto di accedere alla Control Room con un browser
supportato alternativo, come Google Chrome o Microsoft Edge (Chromium), anziché tramite Internet
Explorer. Non sarà più possibile accedere alla Control Room da Internet Explorer. By aligning with the
Microsoft strategy for browser support, we can provide you with enhanced functionality that latest
browsers such as Google Chrome and Microsoft Edge make technologically possible.

Domande frequenti generali

Come faccio a sapere se sarò interessato
dalla fine del ciclo di vita di Internet
Explorer?

Per valutare se sarai interessato dalla fine del ciclo
di vita di Internet Explorer, procedi nel seguente
modo:
• Verifica se l'applicazione legacy o il sito web

sottostanti possono essere eseguiti solo su
Internet Explorer e non vengono spostati su un
altro browser.

• Verifica se il dispositivo su cui è in esecuzione
il bot ha la versione di Windows 10 con licenza
Canale semestrale (SAC).

Se la risposta a entrambe le domande è
affermativa, sarai interessato dalla fine del ciclo di
vita di Internet Explorer.

Qual è il motivo di questo cambiamento? Di recente Microsoft ha annunciato che il 15 giugno
2022 Internet Explorer verrà ritirato per alcune
versioni dei sistemi operativi Windows.
Non forniremo più supporto per la Control Room su
Internet Explorer ma continueremo ad aggiungere
nuove funzionalità avanzate utilizzabili su browser
alternativi.
Requisiti del browser per RPA Workspace on page
866 | Internet Explorer EOL
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Quando terminerà il supporto? A partire dall'imminente versione v.25 di Automation
360, gli utenti che tenteranno di accedere alla
Control Room tramite Internet Explorer dovranno
utilizzare browser alternativi come Google Chrome o
Microsoft Edge (Chromium).

Posso connettermi alla Control Room
Enterprise 11 o Enterprise 10?

Puoi continuare a utilizzare Internet Explorer per
connetterti alla Control Room Enterprise 11.

Cosa accade alle automazioni che ho creato
utilizzando Internet Explorer?

Da giugno 2022 Microsoft non intende più fornire
il supporto per Internet Explorer su alcuni sistemi
operativi. Se questa modifica ti riguarda, dovresti
iniziare a pensare di aggiornare le tue automazioni
in modo che utilizzino altri browser, ad esempio
Microsoft Edge (Chromium).
Consulta Internet Explorer EOL per l'elenco dei
sistemi operativi Windows che supportano Internet
Explorer.
Per informazioni sugli aggiornamenti delle
automazioni basati su scenari, consulta Domande
frequenti sulla migrazione on page 772.

La fine del ciclo di vita influisce sulle
automazioni in esecuzione su sistemi
operativi diversi da Windows 10 Professional
o Enterprise concessi in licenza tramite il
Canale semestrale (SAC)?

No, le tue automazioni non saranno interessate
se sono eseguite su sistemi operativi diversi da
Windows 10 Professional o Enterprise concessi
in licenza tramite SAC. Per ulteriori informazioni,
consulta le domande frequenti di Microsoft.
Internet Explorer EOL

La mia organizzazione dispone di app e siti
Web legacy basati su Internet Explorer 11
e automatizzati tramite Automation 360.
È nostra intenzione spostare le nostre app
legacy in Microsoft Edge con la modalità
Internet Explorer prima della dati di fine
del ciclo di vita. Cosa accadrà alle mie
automazioni create su Internet Explorer 11?

Dopo aver spostato le app legacy in Microsoft Edge
con modalità Internet Explorer, le automazioni
create su Internet Explorer 11 verranno eseguite
solo dopo che le avrai modificate e rese utilizzabili
su Microsoft Edge in modalità Internet Explorer.
È possibile che debba acquisire nuovamente gli
oggetti e aggiornare le azioni corrispondenti sugli
stessi affinché l'automazione possa essere eseguita
correttamente su Microsoft Edge in modalità
Internet Explorer.

La mia applicazione è in esecuzione su
Microsoft Edge in modalità Internet Explorer.
Posso creare ed eseguire automazioni basate
su oggetti su Microsoft Edge in modalità
Internet Explorer usando Automation 360?

Sì, a partire da Automation 360 v.23 le automazioni
basate su oggetti sono supportate per Microsoft
Edge in modalità Internet Explorer. Puoi registrare
oggetti ed eseguire varie operazioni utilizzando il
Universal Recorder per automatizzare le applicazioni
eseguite su Microsoft Edge in modalità Internet
Explorer.

Note:  non è necessaria un'estensione del plug-
in separata. Puoi usare l'estensione del plug-in
Microsoft Edge per il browser Microsoft Edge anche
con la modalità Internet Explorer.
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Automation Anywhere fornirà strumenti
per convertire le automazioni che utilizzano
Internet Explorer in Microsoft Edge?

Microsoft consiglia agli utenti di utilizzare Microsoft
Edge in modalità di compatibilità di Internet
Explorer. Forniremo un'utilità per convertire
le automazioni che usano Internet Explorer
per utilizzare Microsoft Edge nella modalità di
compatibilità di Internet Explorer.

Domande frequenti sulla migrazione

Quali sono le indicazioni per gli utenti di
Automation 360 sulla disponibilità generale
di uno strumento di conversione?

For Automation 360 users, we are planning a patch
release on Automation 360 v.24 for On-Premises
and Cloud users. You must apply this patch to
take advantage of the support for Microsoft Edge
with Internet Explorer mode. This patch contains
packages that are certified on Microsoft Edge in
Internet Explorer mode and a bot update wizard.
Puoi aggiornare manualmente i bots o usare la
procedura guidata per il bot per aggiornare i bots
in blocco affinché funzionino con Microsoft Edge in
modalità Internet Explorer.

Note:  Gli utenti di On-Premises possono accedere
in anticipo a questa patch per testarla nell'ambiente
di sviluppo.

Qual è la guida per gli utenti di Enterprise 11
sulla disponibilità generale di uno strumento
di conversione?

Per gli utenti di Enterprise 11, stiamo pianificando
il rilascio di una patch sul percorso Version 11.3.5.x
per il supporto di Microsoft Edge in modalità
Internet Explorer. You must update to the latest
version to take advantage of this patch. Insieme a
questa patch, verranno rilasciate anche un'utilità
di conversione e una versione ottimizzata di Bot
Scanner. With the enhanced Bot Scanner, you can
get statistics on the usage of Internet Explorer in
your bots so that you can plan and devise an overall
conversion strategy. You can either manually update
your bots or use the conversion utility to convert
your bots in bulk to work with Microsoft Edge in
Internet Explorer mode.

Note:  You can get early access to this patch to
test it in the development (dev) environment.

If you are migrating from Enterprise 11 to
Automation 360, you can combine the migration
and conversion of your bots to use Microsoft Edge
in Internet Explorer mode in a single operation after
updating to the Automation 360 v.24 patch.

What options are available for users
to maintain business continuity if their
automations are being affected by the
Internet Explorer EOL?

You can maintain business continuity by choosing
one of the following options:
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1. Modifica la licenza della versione di Windows da
Canale semestrale (SAC) a Long-Term Servicing
Channel (LTSC).
Per informazioni, consulta Internet Explorer EOL.

2. Aggiorna Windows a una versione diversa da
Windows 10 SAC sul dispositivo su cui sono in
esecuzione le automazioni.
Per informazioni, consulta Internet Explorer EOL.

3. Manually edit the affected bots by recapturing
the application objects by using supported
browsers (other than Internet Explorer)
and change the window titles, variables, or
any of the corresponding actions that are
browser-specific. Convalida l'automazione ed
esegui i bots aggiornati sulle applicazioni di
destinazione nel browser selezionato.

Note:  Questa procedura non è applicabile ai
bots migrati di Enterprise 11 o Enterprise 10
che usano il comando Web Recorder.

4. Ricrea i bots sostituendoli tramite uno dei
browser supportati, come Microsoft Edge o
Google Chrome.

5. Usa lo strumento di conversione fornito da
Automation Anywhere per convertire i bots
basati su Internet Explorer in Microsoft Edge
con modalità Internet Explorer.

Note:  The tool cannot be used to convert bots
built in Internet Explorer to other supported
browsers, such as Google Chrome, Microsoft
Edge (Standard mode), or Mozilla Firefox.

Dopo l'aggiornamento di Windows, le
richieste di Internet Explorer vengono
reindirizzate a Microsoft Edge. La modalità
IE sarà impostata automaticamente o deve
essere impostata manualmente?

• Microsoft consiglia di registrare il sito o
l'applicazione in esecuzione su Internet Explorer
su Microsoft Site List Manager.
Per informazioni, consulta Enterprise Mode and the
Enterprise Mode Site List.

• In alternativa, puoi indicare di aprire alcuni
siti web solo in modalità IE utilizzando le
impostazioni di compatibilità della modalità IE
di Microsoft Edge in Microsoft Edge. Queste
impostazioni devono essere aggiornate ogni 30
giorni.
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Migration scenario A: If you are new to Automation 360 and have bots built using Internet Explorer,
or if you have migrated from Enterprise 11 or Enterprise 10 to Automation 360 and have bots built using
Internet Explorer, review the following information.

Come posso assicurarmi che le mie
automazioni create su Internet Explorer
continueranno a essere eseguite dopo la fine
del ciclo di vita di Internet Explorer?

Per assicurarti che le tue automazioni continuino a
essere eseguite su Internet Explorer dopo la fine del
ciclo di vita, procedi nel seguente modo:
• Registra il sito o l'applicazione in esecuzione su

Internet Explorer su Microsoft Site List Manager.
Per informazioni, consulta Enterprise Mode and the
Enterprise Mode Site List.

• Update Automation 360 to the latest patch on
Automation 360 v.24 release with support for
Microsoft Edge with Internet Explorer mode.

• Utilizza la procedura guidata di aggiornamento
dei bot per convertire ogni bot in esecuzione su
Internet Explorer in Microsoft Edge con modalità
Internet Explorer.
• I Bots che non usano comandi correlati a

Internet Explorer non saranno convertiti.
• Se l'aggiornamento dei bot viene completato

senza errori, verrà creata una nuova versione
dei bot nell'archivio pubblico della Control
Room.

• Check the update bot report to see whether
you need to review the updated bot or take any
action.

• Esegui il bot aggiornato per confermare il
corretto funzionamento di bot in Microsoft Edge
in modalità Internet Explorer.

I am using an earlier version of Automation
360 On-Premises. Can I directly update to
Automation 360 v.24 patch release or should
I manually uninstall the previous version and
install the new patch version?

Yes, you can directly update your existing
Automation 360 version to the latest Automation
360 v.24 patch release.
Note that we support directly updating from
n-3 releases (where n is the latest release). For
updating from a version of Automation 360 earlier
than that, you must perform a multistep update.
For example, if you are on Automation 360 v.19,
you must first update to Automation 360 v.22 and
then to Automation 360 v.24.

Do I need to update my Automation 360 Bot
Agent?

Yes, the Bot Agent needs to be updated.
Starting from the Automation 360 v.24 release, Bot
Agent update is optional with some releases.

Migration scenario B: Se utilizzi Enterprise 11 o Enterprise 10 e prevedi di passare ad Automation 360,
leggi le seguenti informazioni.

Non ho ancora iniziato la migrazione
a Automation 360. Com'è consigliabile
pianificare la migrazione?

La migrazione a Automation 360 comporta la
conversione dei bots di Enterprise 11 o Enterprise
10 in un formato compatibile con Automation 360
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per garantire il corretto funzionamento del bot
convertito in Automation 360.
If these bots are automated using Internet
Explorer 11, then you will have to include the
efforts involved in further converting these bots to
Microsoft Edge with Internet Explorer mode and
validate the bots in the new browser.
Se utilizzi Enterprise 11 e sei interessato dalla fine
del ciclo di vita di Internet Explorer, ti consigliamo
di continuare a utilizzare Enterprise 11 e convertire
i bots correlati a Internet Explorer in Microsoft
Edge con modalità Internet Explorer per testare e
convalidare i bots prima della fine del ciclo di vita.
Per dettagli sullo strumento di conversione, consulta
Enterprise 11 and upcoming Internet Explorer 11 EOL
FAQ. La migrazione a Automation 360 può essere
pianificata in una data successiva in base alle
esigenze.
Se utilizzi Enterprise 10 e sei interessato dalla fine
del ciclo di vita di Internet Explorer, ti consigliamo
di eseguire la migrazione a Enterprise 11 e,
successivamente, di convertire i bots correlati a
Internet Explorer in Microsoft Edge con modalità
Internet Explorer per testare e convalidare i bots
prima della fine del ciclo di vita.
Per dettagli sullo strumento di conversione, consulta
Enterprise 11 and upcoming Internet Explorer 11 EOL
FAQ. La migrazione a Automation 360 può essere
pianificata in una data successiva in base alle
esigenze.
Se prevedi di creare nuovi bots in Enterprise
11 o Enterprise 10, ti consigliamo di utilizzare
Automation 360 con uno dei browser supportati per
ridurre al minimo l'impatto della fine del ciclo di vita
di Internet Explorer.

Migration scenario C: se utilizzi Enterprise 11 o Enterprise 10 e stai eseguendo la migrazione ad
Automation 360, consulta le seguenti informazioni.

Ho eseguito la migrazione a Automation 360
di alcuni bots che utilizzano Internet Explorer
e ho alcuni bots in attesa di migrazione
a Enterprise 11 che utilizzano Internet
Explorer. Qual è il vostro suggerimento in
merito al mantenimento di due ambienti
paralleli?

Se stai eseguendo la migrazione mantenendo due
ambienti paralleli in cui sono presenti bots basati
su Internet Explorer sulle versioni Enterprise 11 e
Automation 360, dovrai assicurarti che i bots siano
convertiti in Microsoft Edge in modalità Internet
Explorer nei rispettivi ambienti nel caso in cui non
sia possibile completare la migrazione dei bots di
Enterprise 11 in sospeso ad Automation 360 prima
della fine del ciclo di vita di Internet Explorer.
For Enterprise 11 bots based on Internet Explorer,
upgrade your Enterprise 11 to the latest Version
11.3.5.x patch release, which supports Microsoft
Edge with Internet Explorer mode. After the
upgrade, use the Enterprise 11 conversion utility to
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convert these bots in Microsoft Edge with Internet
Explorer mode so that these bots continue to run in
Enterprise 11 even after the Internet Explorer EOL.
Similarly, for Automation 360 bots based on
Internet Explorer, update to the latest Automation
360 v.24 patch release, which supports Microsoft
Edge with Internet Explorer mode. After the
update, use the Automation 360 bot update wizard
to convert these bots in Microsoft Edge with
Internet Explorer mode so that these bots continue
to run in Automation 360 even after Internet
Explorer EOL.
In seguito potrai decidere quando eseguire la
migrazione dei bots di Enterprise 11 convertiti in
Microsoft Edge con la modalità Internet Explorer a
Automation 360. Quando deciderai di procedere,
potrai utilizzare la procedura guidata di migrazione
del Bot Automation 360 senza l'opzione Converti i
bot creati con IE in Edge con modalità IE.
Per informazioni, consulta Bot Migration Wizard on
page 1213.

Note:  per i bots di Enterprise 10 basati su Internet
Explorer non abbiamo in programma di rilasciare
una patch su Enterprise 10 che supporti Microsoft
Edge in modalità Internet Explorer. Quindi, gli
utenti di Enterprise 10 devono assicurarsi che i loro
bots basati su Internet Explorer siano trasferiti sulla
patch di Automation 360 v.24.

Come posso sapere quali bots usano comandi
o azioni correlati a Internet Explorer e
devono essere convertiti in Microsoft Edge
con modalità Internet Explorer?

Per i bots di Enterprise 11, puoi eseguire l'utilità Bot
Scanner con un'opzione di scansione dei bots per
l'uso con Internet Explorer. Questa utilità genera
un rapporto in cui sono indicati tutti i bots che
utilizzano comandi correlati a Internet Explorer.
Per i bots di Automation 360, lo strumento per la
scansione dei bots e la generazione del rapporto
di utilizzo di Internet Explorer non è al momento
disponibile.

Do I need to manually change the bot after it
is migrated to Automation 360 using the Bot
Migration Wizard along with the Convert bots
built using IE to Edge with IE mode option?

Yes, only for bots that are migrated to Automation
360 with Action Required or Review Required
messages. Review the messages in the Migration
Report that suggest that the user edit the bot, for
example, if the bot uses a reference of Internet
Explorer in the window title through a variable, file,
and so on.

Per ulteriori domande su questa modifica, contatta il tuo CSM assegnato o il supporto.
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Limitazioni e comportamenti noti

The following table lists known behavior and limitations that apply to bots migrated from Enterprise 11 to
Automation 360 and to Automation 360 bots that run on Microsoft Internet Explorer and are converted to
Microsoft Edge with IE mode.

Descrizione Applies to
Enterprise 11 to
Automation 360
(migration)

Applies to
Automation 360
to Automation
360 (updating)

The bot conversion utility updates only bots that use
Internet Explorer for automations and does not update bots
that use other browsers.

Sì Sì

For web pages or URLs to open in Microsoft Edge with
Internet Explorer mode, you must register your site or
application running on Internet Explorer to Microsoft Site
List Manager or Group Policy within your organization.
Enterprise Mode and the Enterprise Mode Site List

Sì Sì

The Open Program/File command that contains a variable
to store the location of the program or file property is not
migrated or converted to use Microsoft Edge with Internet
Explorer mode. If the variable is pointing to Internet
Explorer, update it to point to Microsoft Edge browser
instead.

Sì Sì

The following commands are not migrated or converted
because browser components such as the menu bar, status
bar, favorites bar, command bar, and other non-web page
components differ in each browser. This can potentially
impact captured screens or properties of the actions. We
recommend that you review and recapture the screen or
update the properties if required.
• Image Recognition
• OCR
• Mouse
• Wait> Wait for screen (Menu/Non-HTML objects)
• Screen
• Recorder
• App Integration > Acquisisci l'area

Sì Sì

Keystroke action that is based on the menu bar of a
browser is not migrated or converted.

Sì Sì

For Mouse commands such as Click, Move or Scroll,
due to the difference in header bar height in Internet
Explorer and Microsoft Edge with Internet Explorer mode,
there might be an incorrect Y-axis after the migration or
conversion.

Note:  This difference applies only to the Y-axis and not X-
axis.

Sì Sì
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Descrizione Applies to
Enterprise 11 to
Automation 360
(migration)

Applies to
Automation 360
to Automation
360 (updating)

In the Image Recognition command, when the target image
is on the lower and upper boundaries of the source image,
the command is not migrated or converted because of
the difference in the height of the header bar in Internet
Explorer and Microsoft Edge browsers. Sono interessate le
seguenti azioni: Fai clic con il tasto destro, Fai clic con
il tasto sinistro e Fai doppio clic.

Sì Sì

Review and recapture all commands, except Image
Recognition that captures window coordinates with negative
values, after migration or conversion.

Note:  In Enterprise 11, the coordinates are captured
the top-left of the screen at 0, 0. In Automation 360, the
coordinates are captured as negative values.

Sì Sì

Due to differences in the height of the header bar in
Internet Explorer and Microsoft Edge with Internet Explorer
mode, the output of the actions might not be as expected.
Sono interessati i seguenti comandi:
• OCR> Acquisisci l'area
• Mouse

• Pulsante: Pulsante sinistro, pulsante medio, pulsante
destro.

• Evento: Clic singolo, Doppio clic, Pulsante Giù,
Pulsante Su.

• Screen> Acquisisci l'area

Sì Sì

Window titles with regular expression variables containing
partial text from Internet Explorer might be converted
to the corresponding title in Microsoft Edge. However,
sometimes the conversion might not happen. Ad esempio:
• Internet
• .Int,
• Int
• Expl*
• .Expl
• Internet Exp

Sì Sì

Using the Microsoft registry setting, if you have changed
the default text of the Internet Explorer window title bar to
your preferred text, the changes applied on the title bar are
not available after conversion.

Sì Sì
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Descrizione Applies to
Enterprise 11 to
Automation 360
(migration)

Applies to
Automation 360
to Automation
360 (updating)

In the Open Program/File, if you have used the
taskkill /F /IM iexplore.exe command to
terminate Internet Explorer, then after conversion, when
you run the bot, it will forcefully terminate msedge.exe.
But when you run the bot for the second time, it will display
a Microsoft Edge Closed Unexpectedly error
message. We recommend that you avoid the use of /F so
that the bots run seamlessly.

Sì Sì

Local HTML files are not supported for loading in Microsoft
Edge with Internet Explorer mode through Enterprise Site
List Manager.
Soluzione: You can deploy the local HTML file in localhost.
Esempio: The file:///C:/SampleHTML/sample.html
URL will be replaced with https://localhost/
SampleHTML/sample.html

Sì Sì

The wait for the browser does not work for Microsoft
Edge with Internet Explorer mode for commands such as
Mouse, Insert Keystrokes, or Recorder. After conversion,
the User32 API does not return the child window list. As a
result, it cannot find the page Microsoft Edge with Internet
Explorer mode.

Sì Sì

Object Cloning commands developed on a Citrix
environment with Xen App Remote Agent and Microsoft
Edge with Internet Explorer mode are not supported.
Object Cloning commands developed on Silverlight and
Flash technologies and Microsoft Edge with Internet
Explorer mode are not supported.

Sì Non applicabile
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Descrizione Applies to
Enterprise 11 to
Automation 360
(migration)

Applies to
Automation 360
to Automation
360 (updating)

• Object Cloning commands (with coordinates play mode)
where Internet Explorer based toolbar is enabled and
locked are not migrated or converted.

• Object Cloning commands (with coordinates play
mode) are not migrated or converted because browser
components such as menu bar, status bar, favorites bar,
command bar, and other non-web page components
differ in each browser. This can potentially impact the
captured screens or the properties of the actions. We
recommend that you review and recapture the screen or
update the properties if required.

• Due to the difference in the height of the header bar
in Internet Explorer and Microsoft Edge with Internet
Explorer mode, an incorrect Y-axis might occur after the
migration or conversion. This difference can be seen in
Get text, Set text, Left click, Right click, Middle
click, Double click of the coordinates play mode.

Note:  This difference applies only to the Y-axis and not
X-axis.

Sì No

Migrated bots with Mouse Click command might not work
as expected when the Relative to property is Screen. This
is because of the difference in the offset of the address bar
between Internet Explorer and Microsoft Edge.

Sì Sì

Objects captured on Internet Explorer using Standard or
Legacy technology in the Object Cloning command will not
work after migration or conversion.

Sì No

The commands that store window titles with wildcard
characters such as *Applet* are based on the Internet
Explorer browser window with Web Java technology. If
you have selected the None of the above option for
such commands, note that the commands will not work in
Microsoft Edge with IE mode as these are not migrated to
Edge.

Sì No

Bot Scanner does not count the commands that use
variables to store the window title as part of the statistics.
However, these commands are displayed in the Review
Required tab so you can review these commands
manually to verify if the window title is based on the
Internet Explorer browser window.

No Sì

User Interface (UI) based and window triggers with
Internet Explorer based window title are not migrated or
converted.

No Sì
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Descrizione Applies to
Enterprise 11 to
Automation 360
(migration)

Applies to
Automation 360
to Automation
360 (updating)

Recorder developed on a Citrix environment with Xen App
Remote Agent, and Microsoft Edge with Internet Explorer
mode is not supported.
Recorder actions developed on Silverlight and Flash
technologies and Microsoft Edge with Internet Explorer
mode is not supported.

Non applicabile Sì

For the Bot Migration Wizard and Update Bot wizard,
when you select the Bot Assistant screen to view the
migration review and action messages, the review message
is not displayed based on the version. In the Update Bot
Assistance menu, the review message is overridden by
the migration review message.

No Sì

When you use the Update Bot wizard to convert Automation
360 bots that run on Microsoft Internet Explorer to
Microsoft Edge, the In progress status will be shown
indefinitely for the following scenarios:
• When the bot fails to compile
• When the bot fails to deploy
• When the Bot Agent service stops or fails
• When the Bot Runner user is not assigned the Allow a

Bot user to update bots permission

Non applicabile Sì

Related concepts
Microsoft Internet Explorer EOL overview on page 766
Microsoft has announced retiring Internet Explorer (IE) for certain versions of Windows operating systems
and recommends impacted users to move their apps or websites running on IE to Microsoft Edge with IE
mode.
Microsoft Internet Explorer EOL overview on page 766
Microsoft has announced retiring Internet Explorer (IE) for certain versions of Windows operating systems
and recommends impacted users to move their apps or websites running on IE to Microsoft Edge with IE
mode.
Related reference
Note sulla versione di v.24R2 Automation 360 per EOL Internet Explorer 11 on page 259
Related information
Enterprise 11 and upcoming Internet Explorer 11 EOL FAQ

Scansione di bots Automation 360 per l'utilizzo di Internet Explorer
La fine del ciclo di vita (EOL) di Microsoft Internet Explorer è prevista per giugno 2022 e Microsoft consiglia
di trasferire su Microsoft Edge le applicazioni e i siti web legacy in esecuzione su Internet Explorer con
la modalità IE. Utilizza l'utilità Automation 360 Bot Scanner per IE per effettuare la scansione dei tuoi
Automation 360 bots per l'utilizzo di Internet Explorer.
• Assicurati che l'utente della Control Room abbia l'autorizzazione Visualizza il contenuto nella cartella

Bot.
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• Assicurati di soddisfare i seguenti requisiti di sistema per l'utilizzo di Bot Scanner:
• Requisiti hardware

Processore 2,66 GHz o superiore (64 bit)

RAM 2 GB o superiore

Spazio su disco 200 MB

• Requisiti software
Sistemi operativi: Windows 7 o versioni successive (a 32 o a 64 bit)

1. Accedi a A-People Downloads page (Login required).
2. Scarica automation-360-bot-scanner-for-ie-1.0.zip da Automazione 360 v.24 R2

(13343) > Installazione e configurazione.
3. Extract the files from the zip file you have downloaded and double-click the executable file to run the

utility.
4. Fai clic su Inizia.
5. Immetti l'URL della Control Room di Automation 360 (On-Premises o Cloud) a cui ci vuoi connetterti e

accedi all'archivio Bot che contiene i bots Internet Explorer che si desideri scansionare.

Note:  The Bot Scanner for IE utility does not support a proxy server. If you use a proxy to provide
the Control Room URL, you will not be able to establish the connection.

6. In base al tipo di autenticazione configurato nella tua Control Room, scegli uno dei seguenti metodi di
autenticazione nel campo Tipo di autenticazione:
Tipo di autenticazione Fasi

Database a. Inserisci il nome utente (nome utente del
database della Control Room).

b. Inserisci la password (password utente
della Control Room).

Active Directory (metodo predefinito) a. Inserisci il nome utente (dominio\\\nome
utente).

b. Inserisci la password (password utente del
dominio).

Single Sign-On a. Immetti il nome utente.
b. Immetti la chiave API.

7. Fai clic su Verifica la connessione.
Viene visualizzato un messaggio di avvenuta connessione o di errore. Se la connessione non viene
stabilita, ricontrolla le credenziali.

8. Nel campo Seleziona il percorso di destinazione, immetti il percorso in cui desideri salvare il
rapporto generato.

9. Fai clic su Scansiona bot.
Lo scanner esegue la scansione di tutti i bots nell'archivio Control Room per l'utilizzo con Internet
Explorer. Al termine della scansione, viene generato un rapporto (file .CSV) contenente tutti i dettagli.
Se nella cartella di output è già presente un file .CSV, viene visualizzato un messaggio che indica che
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il vecchio file .CSV verrà eliminato e, dopo aver fatto clic su Continua, viene generato un nuovo
file .CSV. Se il vecchio file .CSV è in uso, viene visualizzato un messaggio che indica che il file non può
essere eliminato. Chiudi il file e riprova.

10. Fai clic su Apri rapporto per analizzare il rapporto generato dallo scanner e ottenere le statistiche di
utilizzo di Internet Explorer nei tuoi bots.
Il rapporto contiene i seguenti dettagli:
• Nome TaskBot: il nome del TaskBot
• Numero di riga: il numero della riga del bot in cui è utilizzato il browser Internet Explorer
• Nome Package e action: il nome del package e dell'action in cui viene utilizzato il browser Internet

Explorer
• Testo cercato: fornisce il titolo della finestra o del browser
• Messaggio di azione e revisione: contiene le revisioni o le azioni richieste dall'utente dopo la

conversione
• Percorso TaskBot: il percorso all'archivio in cui risiede il bot

Note:  Sulla base del rapporto generato dallo scanner, è possibile pianificare e implementare una
strategia per convertire i bots che utilizzano Internet Explorer su Microsoft Edge con la modalità IE. Il
rapporto consente di identificare:
• I nomi univoci dei TaskBot che utilizzano Internet Explorer
• L'action in ogni bot che utilizza Internet Explorer
• Se un'action può essere convertita o meno
• Se un'action necessità di revisione dopo la conversione

See the following video on how to scan Automation 360 bots for Internet Explorer usage:

Bot Scanner non converte i bots da Internet Explorer a Microsoft Edge con la modalità IE. Per la
conversione, è necessario utilizzare la procedura guidata di aggiornamento dei bot. Consulta Update Bot
wizard for converting IE bots on page 786.

Analyze report for Internet Explorer bots
You can analyze the report generated by the Bot Scanner to get usage statistics about Internet Explorer
used in your bots.
Based on the report that Bot Scanner generates, you can plan and implement a strategy to convert bots
that use Internet Explorer to Microsoft Edge with IE mode.
Bot Scanner provides the following information about these bots:
• Numero di bots analizzati
• Number of bots scanned for Internet Explorer usage and those that were not scanned
• Internet Explorer usage statistics on the percentage and number of bots using Internet Explorer
• Reasons for bots that were not scanned
• Reviews required by users after conversion

The Bot Scanner is designed to scan bots (TaskBots and MetaBots) created using bothEnterprise 10 and
Enterprise 11 versions of Enterprise Client. Il conteggio totale dei file include il numero di file che sono stati
ignorati e non scansionati.
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Folder location and reports

I report sono disponibili nella posizione di output specificata nel campo Seleziona cartella di
destinazione nella finestra di dialogo Bot Scanner Automation Anywhere. Bot Scanner genera un
report di riepilogo e un report separato per ciascun bot sottoposto a scansione. Crea un report separato
per ogni logica disponibile in un MetaBot.
Viene creata una cartella di dati non elaborati contenente i report (in formato XML) per ogni bot
scansionato. It helps our developers to further analyze the scanning process and take corrective actions, if
required. Le informazioni che consentono l'identificazione personale dell'utente (PII) non sono incluse nel
report di riepilogo o nei singoli report del botsscansionato.
If you choose to share the reports with us to help improve the product, compress the files in the rawdata
folder and coordinate with your Customer Success Manager (CSM) or Partner Enablement Manager (PEM).
Nessun dato viene condiviso automaticamente con Automation Anywhere.
The system creates three folders within the raw-data folder that contain various reports:
• Migratable_Bots: Contains reports of bots that are possibly using Internet Explorer.
• Failed_to_Analyze: Contains reports of bots that Bot Scanner failed to analyze.
• MetaBots: Contains reports of MetaBots that can and cannot be migrated to Automation 360 and the

ones that the Bot Scanner failed to analyze.

Rapporto riepilogativo per tutti i bots

The summary report provides information about the total number of bots scanned, the number of bots
scanned for Internet Explorer usage, the number bots that could not be scanned. It also provides Internet
Explorer usage statistics about the percentage and number of bots using Internet Explorer.
Ad esempio, ipotizza che Bot Scanner abbia scansionato 31 bots. Of the 31 bots, consider 26 bots are
scanned for Internet Explorer usage, and 0 bots could not be scanned. The percentage of bots using
Internet Explorer is 84%.
Revisione del report di Bot Scanner
Consider a scenario where you have scanned a total of 72 bots, of which 22 bots are scanned for Internet
Explorer usage and 3 bots could not be scanned. In such a scenario, the report enables you to perform the
following actions:
• Identity bots (8) that require review after conversion and take action if required.
• Identify bots (14) that do not require any review after conversion.
• Identify the reason why the bots (3) cannot be currently scanned for Internet Explorer usage. The

reason might be that the bot is built using a version earlier to Enterprise 10 such as Enterprise 8.

L'immagine seguente è un report di esempio di Bot Scanner:
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La seguente tabella descrive i vari campi del report di esempio di Bot Scanner (come riportato
nell'immagine precedente):

Campo/
Opzione

Descrizione

• Bots scanned for IE usage > Review required > Bots: Go to this view for
a list of bots (8 in this scenario) that should be reviewed after conversion.

• Per visualizzare il messaggio di revisione richiesto per uno specifico bot, fai clic
sul nome del bot. The message provides information about changes if any are
required in the bot after conversion.

Bots scanned for IE usage > No review required > Bots: Go to this view for
a list of bots (14 in this scenario) that do not require any review after conversion.
Fai clic su qualsiasi nome di bot nell'elenco per visualizzare il report XML offline.
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Campo/
Opzione

Descrizione

• Bots that can't be scanned now > Bots: Go to this view for a list of bots (3
in this scenario) that cannot be currently scanned.

• Per visualizzare il messaggio di errore per uno specifico bot, fai clic sul nome
del bot. An XML report opens in a new tab where you can view the error due to
which the bot cannot be scanned.

Download (as a CSV file) the list of bots or commands that can or cannot be
scanned so that you can review the file offline or share the file with others.

Report validity

Il report sarà valido fino a quando non sarà disponibile la successiva versione di Bot Scanner. When the
next version is available, a report expiry message is displayed. You must download the latest version of Bot
Scanner and use that version to scan the bots again.

Update Bot wizard for converting IE bots
Use the Update Bot wizard to convert Internet Explorer bots created in Automation 360 to Microsoft Edge
with IE mode.
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• Ensure you are logged in as an administrator or have given the following permissions to the user
performing the bot update and to the Bot Runners you have selected:
• Users performing the bot update:

• View bot update
• Manage bot update
• View Users and Roles basic information
• View everyone's audit log actions
• View packages
• View my bots
• Run my bots
• You must have the below-mentioned permissions for Bots, Sample bots, and the folders

containing the bots you want to update:
• Run
• Check in
• Check out
• View content

• A role that has access to Bot Runners that you want to select for running the update (on the
Administration > Bot update > Bot Runners page)

• Bot Runners:
• Licenza Bot Runner non assistito
• Stato Accesso automatico impostato
• Allow a bot-runner user to update bots
• Create folders
• View packages
• Register device
• View my bots
• Run my bots
• Below permissions for the folders containing the bots you want to update,

• Check in
• Check out

• Default device settings

For more information on creating users and roles, see Create a user on page 2684 and Create a role on
page 2693.

• The Internet Explorer bots should already be identified for conversion.
• The bots must be Checked in and available in the Public workspace.

Note:  You cannot use the Update Bot wizard to convert Enterprise 10 and Enterprise 11 bots created
using Internet Explorer. Per informazioni, consulta Bot Migration Wizard on page 1213.

See the following video for an overview of the Bot update wizard:
1. Navigate to Administration > Bot update in the Control Room.

If you have not performed any bot updates previously, the Bot update list on the Bot update page
will not display bot updates.

2. Click Update bots to open the Update Bot wizard.
3. In the Settings tab, add details such as the name and description to update bots.
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4. Fai clic su Avanti.
5. On the Bots tab, navigate to the Bots folder that contains the Internet Explorer bots.
6. Select bots from the list of available files and add the bots to the list of selected files.

You can choose from the latest or production version bots.

Note:  You do not have to select the dependent bots because the dependent bots are selected
automatically.

7. Fai clic su Avanti.
8. Select Bot Runner devices from the list of Bot Runners to run the bot update.
9. Fai clic su Avanti.
10. Verify details such as the bot type, name, version, and folder path on the Bot and Dependent Bots tab.
11. Click Update bots.

The selected bots and dependent bots are deployed on the selected Bot Runners for conversion from
IE to Microsoft Edge with IE mode. The bots are converted one at a time and a new version of the
bots is uploaded to the Control Room public repository. A new entry for updated bots is created during
the bot conversion process on the Bot update list page.
The page shows the status and summary of the bots updated for conversion. You can refresh the
page to view the current bot conversion status.

A list of the different bot conversion status during the conversion process is as follows:
• In progress: Indicates that the bot conversion has started.
• Completed: Indicates that the bot conversion process is completed.
• Failed: Indicates that the conversion of one or more bots has failed.

12. Select View update bots details from the actions menu ( ) to view the bot conversion details of
each bot.
See Conversion report for IE bots.

© 2023 Automation Anywhere. All rights reserved.     788



    Automation Anywhere - Learn

See the following video on how to run the Bot update wizard:

Related concepts
Bot permissions for a role on page 2706
Assign bot permissions when creating a role with the View my bots feature permission.
Related reference
Autorizzazioni per le funzioni di un ruolo on page 2694
Un utente con il ruolo AAE_Admin o un ruolo personalizzato con l'autorizzazione Gestisci ruoli può
creare e assegnare ruoli agli utenti, per fornire loro l'accesso a funzionalità e operazioni.

Viewing conversion details for Internet Explorer bots
For each update bot action, you can view details about the overall summary and status of individual bot
conversion that is converted from Internet Explorer to Microsoft Edge with IE mode.

Viewing bot details

1. In the Control Room, go to Administration > Bot update.
2. Select an instance of the bot conversion from the list and click View update bot details action from

the action menu for that instance.
The Update details page opens with detailed information about the name of the instance and the
overall status of the bot conversion (at the top of the page). For more information, you can navigate
to different tabs on this page: Summary, Settings, Bot Runners, and Results.

Summary details

You can view the following details in the Summary tab:
• Start time: Indicates the time when the bot conversion started
• End time: Indicates the time when the bot conversion completed
• Duration: Total duration taken for bot conversion to complete
• Completed items: Total list of items that are converted with completed status
• Failed items: Total list of items that failed to convert
• Skipped items: Total list of skipped items during conversion based on appropriate reasons
• Details of the selected bots and dependencies, listed in a table

The data is listed by file name by default. You can search for specific bots and dependencies by file name.

Impostazioni

The Settings tab displays the following fields:
• Description: Displays any description you might have added before running the Update Bot wizard
• Update the bots built using Internet Explorer to Microsoft Edge Internet Explorer mode. By default, this

field is set to Yes
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Bot Runners

This tab displays the list of Bot Runners on which the bot conversion is done.

Risultati

View the status of individual bot conversion on this tab:
• Status: Status of the individual bot conversion (completed, skipped, failed)
• Type: Type of the bot, for example TaskBot
• File name: il nome del bot
• Folder path: Path where the bot resides in the public workspace
• Bot Runner: The Bot Runner machine used to perform the bot conversion
• Reason: Reason why the bot conversion is in either failed, skipped, completed with review required, or

completed with action required status
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When you click the View Bot update for an individual bot status entry in this tab, the following reason
and action values for the bots are shown.

Stato Motivo Azione

In sospeso - -

Completato - -

Elemento saltato The bot is not updated as it
does not use actions based on
Internet Explorer

-

Completed with Review
Required

The bot has some actions
updated that requires your
review

View bot update issues

Completed with Action Required The bot has some actions
updated that requires your
action

View bot update issues

Operazione non riuscita The bot uses some actions that
are not supported for update to
Microsoft Edge with IE mode

View bot update issues

The view bot update page displays the following columns:
• Numero di riga
• Action name
• Reason for Recommendation

You can view the information listed in the reason column for the line number and open the corresponding
bot, go to the line number and review based on the information provided in the window or take action as
required.
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Deprecation of Basic authentication in Exchange Online
Microsoft will permanently disable Basic authentication for specific protocols in Exchange Online starting
from October 1, 2022. This impacts customers running bot for email automation that connect to Exchange
Online using IMAP, POP3, or EWS protocols with Basic authentication.

Important:  We have updated the Email package and Email trigger with newer versions as mentioned
below:

Package or trigger New version Old version

Pacchetto Email • Version:
3.14.3-20220923-220748

• Filename: bot-command-
email-3.14.3.jar

• Version:
3.14.1-20220831-084727

• Filename: bot-command-
email-3.14.1.jar
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Package or trigger New version Old version

Trigger Email • Version:
2.8.3-20220923-171042

• Filename: bot-trigger-
email-2.8.3.jar

• Version:
2.8.1-20220831-123116

• Filename: bot-trigger-
email-2.8.1.jar

We recommend that you update your impacted bots with the new versions as they are compatible with the
upcoming Automation 360 v.27 release. If you continue to use the old versions and update to Automation
360 v.27 release, you might encounter issues when importing or exporting of bots or when uploading
the old versions of the Email package or trigger to Automation 360 v.27. To resolve this issue, see the
workaround provided in Everything about Basic Authentication deprecation in Microsoft Exchange online (A-
People login required).

We will provide a new version of the Email package with OAuth 2.0 support in an upcoming Automation
360 package-only release by the week of August 29, 2022.
To ensure that your existing bots that are using Basic authentication in Exchange Online are supported
after Basic authentication is deprecated, we recommend that you update the bots to use OAuth 2.0. To
identify the Automation 360 bots that are using Basic authentication in the Email package or Email trigger,
use the Bot Scanner to scan bots. This helps you to plan your efforts to update your existing bots to OAuth
2.0 in Automation 360.
• Panoramica di Bot Scanner on page 1158
• Scan Automation 360 bots for Email action with Basic authentication usage on page 803

Update Automation 360 bots to use OAuth 2.0

1. Update to the latest Automation 360 release.
Aggiornamento alla versione di Automation 360 più recente on page 1063
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2. Back up the Control Room repository.
Integrating Control Room with Git repositories on page 2753

3. Identify bots that are using Basic authentication using the Bot Scanner.
Scan Automation 360 bots for Email action with Basic authentication usage on page 803

4. Download the latest version of the Email package and add it to your Control Room.
Add packages to the Control Room on page 2649

5. Update the bots that are using Basic authentication in the Connect, Send, Forward, or Reply
actions or Email trigger to use OAuth 2.0.
Update bots using Basic authentication to OAuth 2.0 on page 794

6. Verify that the updated bots can be deployed.
Run a bot on page 1994

Note:  You can update your bots to use OAuth 2.0 in one environment (for example, development or
DEV) and then move these bots to another environment (for example, UAT and production or PROD)
without updating the bots in each environment.

Protocols impacted for Basic authentication deprecation

Microsoft is removing the capability to use basic authentication in Exchange Online for these specific
protocols: MAPI, RPC, Offline Address Book (OAB), Exchange Web Services (EWS), POP, IMAP, Exchange
ActiveSync (EAS), and Remote PowerShell.

Note:  SMTP AUTH is excluded from this deprecation.

Any client (for example, user app, script, or integration) using Basic authentication for one of the affected
protocols will not be able to connect to Exchange server starting October 1, 2022. An HTTP 401 error (bad
username or password) will be displayed.

Note:  Any app using OAuth 2.0 for these same protocols will not be impacted.

Per ulteriori informazioni, consulta Basic authentication deprecation in Exchange Online – Updates.

Update bots using Basic authentication to OAuth 2.0

You should update your bots that are using Basic authentication to OAuth 2.0 in the Connect, Forward,
Reply, and Send actions of the Email package and Email trigger before Basic authentication is
deprecated.

Note:  This procedure is applicable to both Automation 360 Cloud and On-Premises customers.

Prerequisiti
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• The Installation Setup folder in the Automation 360 v.25 Basic Authentication MS
 Online - Deprecation downloads folder contains the following JAR files:
• Email package (bot-command-email-3.14.1.jar)

Ensure that you download this package and add it to your Control Room in Automation 360.
• Email trigger (bot-trigger-email-2.8.1.jar)

Ensure that you download this package and add it to your Control Room in Automation 360
• Trigger listener (triggerlistener.jar)

If you are on Automation 360 v.25 release, ensure that you download and install the trigger listener
file. Consulta Install the trigger listener file on page 797.

For information on adding packages to the Control Room, see Add packages to the Control Room on page
2649.
To download these JAR files, see Everything about Basic Authentication deprecation in Microsoft Exchange
online (A-People login required).

• Ensure that you have run the Bot Scanner utility for the deprecated features to identity the bots that
are using Basic authentication in your Control Room repository.
Consulta Scan Automation 360 bots for Email action with Basic authentication usage on page 803.

• Ensure that you have registered your application on the Azure portal and performed the following
configurations for Client credentials flow:
• IMAP/POP3

1. Register an application

2. Authenticate an IMAP, POP or SMTP connection using OAuth

• EWS
1. Register an application

2. EWS OAuth authentication

3. Configure application access policy

Procedure
1. Log in to your Control Room as Bot Creator.
2. Select the bot that was identified in the Bot Scanner report for updating.
3. Check out the bot to edit it.
4. In the Bot editor, click the vertical ellipsis in the top right-corner and click Packages.
5. Expand the row for the Email package.
6. From the drop-down list of package versions, select the Default version.

Note:  For Email package, ensure that the package version is 3.14.1-20220831-084727 or later.
For Email trigger, ensure that the package version is 2.8.1-20220831-123116 or later.

7. Click Change Version and Save.
8. Click Return to editor.
9. Click the Email action or Email trigger that is using the Basic authentication mode.
10. Click the Email server or EWS server option.
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11. In the Authentication mode drop-down list, choose the required OAuth 2.0 mode.

Note:  For unattended Email automation, use Client credentials or ROPC flows, and for attended Email
automation, use Implicit or PKCE flows. Microsoft does not recommend the use of ROPC and Implicit
legacy flows. Therefore, we recommend that you either use the Client credentials or PKCE flow.

The following table provides information about the OAuth 2.0 authentication modes that are available
for Email action in the Email server and EWS server options:

Azioni Email Email server Server EWS

Connetti • OAuth2 – Authorization
code with PKCE

• OAuth2 – Client
credentials

• OAuth2 – ROPC
• OAuth2 – Implicit
• OAuth2 – Authorization

code with PKCE
• OAuth2 – Client

credentials

Invia OAuth2 – Authorization code
with PKCE

• OAuth2 – ROPC
• OAuth2 – Implicit
• OAuth2 – Authorization

code with PKCE
• OAuth2 – Client

credentials

Inoltra OAuth2 – Authorization code
with PKCE

--

Rispondi OAuth2 – Authorization code
with PKCE

--

The following table provides information about the OAuth 2.0 authentication modes that are available
for Email trigger in the Email server and EWS server options:

Trigger Email server Server EWS

Trigger Email OAuth2 – Client credentials OAuth2 – Client credentials

• OAuth2 – ROPC: Uses Resource Owner Password flow (Microsoft identity platform and OAuth 2.0
Resource Owner Password Credentials)

Note:  The existing Silent flow has been renamed to ROPC.

• OAuth2 – Implicit: Uses implicit grant flow (Microsoft identity platform and implicit grant flow)

Note:  The existing Interactive flow has been renamed to Implicit.

• OAuth2 – Authorization code with PKCE: Uses authorization code with PKCE grant flow
(Microsoft identity platform and OAuth 2.0 authorization code flow)

• OAuth2 – Client credentials: Uses client credentials flow (Microsoft identity platform and the OAuth
2.0 client credentials flow)
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12. Depending on the authentication mode that you selected, you might have to update some of the
following fields:
• Nome utente: Enter the username that you want to use to access the mail server.

Ad esempio, john.smith@myCompanyName.com
• Password: Enter the password for the username you provided.
• Email provider: Select the email provider from the drop-down list.

Note:  For Client ID, Tenant ID, Redirect URI, and Client secret options, use the information
that is provided for your account on your Azure portal.

Consulta Email package on page 1493 e Add an email trigger on page 2208.
13. For EWS server, click Test connection to sign in to your account, accept the permissions requested

to authenticate, and establish a connection with the server.

Note:  In the Microsoft Azure app registrations portal, in Manage > Authentication, ensure that
the URI you have added is either https://outlook.office365.com or https://outlook.office365.us for the
connection to work properly.

14. Fai clic su Salva.

Repeat these steps for all the impacted bots and run the bots to ensure that they can connect to Exchange
Online using OAuth 2.0 successfully.

Install the trigger listener file

To use the Email trigger with OAuth 2.0, you have to update the triggerlistener.jar in the Bot
Agent.
1. In the Windows Task Manager, stop the Automation Anywhere Bot Agent service.
2. Go to the folder where the Bot Agent is installed (C:\Program Files\Automation Anywhere

\Bot Agent).
3. Locate the triggerlistener.jar file and rename the file to triggerlistener.jar_old.
4. Copy the downloaded triggerlistener.jar.
5. In the Windows Task Manager, start the Automation Anywhere Bot Agent service.

Altre risorse

• Automation 360 and Basic authentication deprecation FAQ on page 798
• Scan Automation 360 bots for Email action with Basic authentication usage on page 803
• Everything about Basic Authentication deprecation in Microsoft Exchange online (A-People login required)
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Automation 360 and Basic authentication deprecation FAQ
Microsoft has announced EOL for Basic authentication that is used to connect to Exchange Online. This will
impact automations (bots) using Email package or Email trigger that uses Basic authentication. Review the
FAQ for details about the deprecation of Basic authentication.

What is Basic authentication deprecation? Microsoft has announced that starting October 1,
2022, Basic authentication will be permanently
turned off (disabled) for specific protocols in
Exchange Online for MAPI, RPC, Offline Address
Book (OAB), Exchange Web Services (EWS), POP,
IMAP, Exchange ActiveSync (EAS), and Remote
PowerShell.
Exclusion: SMTP AUTH is excluded from this
deprecation for tenants which are already using it
Any client (user app, script, integration, and so
on) using Basic authentication for one of the
affected protocols will be unable to connect after
that specified date. The app will display an HTTP
401 error: bad username or password. Any
app using OAuth 2.0 for these protocols will be
unaffected.
Basic authentication in Exchange Online

What is Microsoft's recommendation to
mitigate Basic authentication deprecation?

Per Microsoft's recommendation, you are requested
to switch from Basic authentication to OAuth 2.0 if
your clients or apps are using Basic authentication
with any of the affected protocols to connect to
Exchange server via Exchange Online.

Note:  The Basic authentication deprecation applies
to Exchange Online only and not to Exchange on-
premises version.

Qual è il motivo di questo cambiamento? Basic authentication is an outdated industry
standard, less secure, and poses high risks to
accessing customers' sensitive data. The latest
industry standard is OAuth 2.0 which is more secure
and less vulnerable to cyber attacks.

What if I am not ready for this change? If you are not ready to switch to OAuth 2.0 by
October 1, 2022, Microsoft has provided a one-
time re-enablement option that will allow you to
continue to use Basic authentication for specific
protocols until end of December 2022. Per the
Microsoft announcement, customers will be able
to use the self-service diagnostic to re-enable
Basic authentication for any protocols they need,
once per protocol. After the diagnostic is run, Basic
authentication will be re-enabled for the specified
protocols and will stay enabled until the end of
December 2022.
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Note:  During the first week of calendar year 2023,
the specified protocols will be disabled for Basic
authentication use permanently.

Basic Authentication Deprecation in Exchange Online –
September 2022 Update

Where is Basic authentication used in
Automation 360 product?

In Automation 360, the Basic authentication feature
is available in the Connect, Send, Forward,
and Reply actions of the Email package and in
Email trigger where you configure connection
parameters using any of the IMAP, POP3, SMTP, or
EWS protocols.

How do I know if I am going to be impacted
by Basic authentication deprecation?

Basic authentication deprecation will impact you for
the following cases:
• If you are automating email using Email package

or Email trigger
• If you are using Basic authentication to connect

to Exchange Online
• If you are using the IMAP, POP3, or EWS

protocol

When Basic authentication will be disabled by
Microsoft starting October 1, 2022, then all the
Automation 360 bots for Email automation that
meets the previously mentioned criteria will fail
because the bot cannot connect to the Email server.

Quando terminerà il supporto? Basic authentication will be disabled by Microsoft
starting October 1, 2022.

How can I identify Automation 360 bots
in my repository that are using Basic
authentication with Email package or Email
trigger?

For Automation 360 bots, you can run the Bot
Scanner utility for EOL features.
Scan Automation 360 bots for Email action with Basic
authentication usage on page 803
• The scanner will scan all the bots that are using

Basic authentication with Email package or
Email trigger and having IMAP, POP3, or EWS
protocols.

• The scanner will then generate a CSV output
listing all the impacted bots, including the
specific line numbers and the specific actions to
be performed.

Which feature will be provided in
Automation 360 to mitigate the risk of Basic
authentication deprecation?

The OAuth 2.0 feature will be available in
Automation 360 in the Email package for the
Connect, Send, Forward, and Reply actions and
Email trigger for IMAP, POP3, and EWS protocols so
that you can use this feature to switch from Basic
authentication to OAuth 2.0.

© 2023 Automation Anywhere. All rights reserved.     799

https://techcommunity.microsoft.com/t5/exchange-team-blog/basic-authentication-deprecation-in-exchange-online-september/ba-p/3609437
https://techcommunity.microsoft.com/t5/exchange-team-blog/basic-authentication-deprecation-in-exchange-online-september/ba-p/3609437


    Automation Anywhere - Learn

What is the schedule and release version
for introducing the OAuth 2.0 feature in
Automation 360?

The OAuth 2.0 feature will be delivered as a
package only release in the week of August 29,
2022. This release will include the following:
• Bot Scanner utility
• Updated versions of Email package, Email

trigger, and trigger listener

Where can I download the Email package? You can download the Email package from the
link in the following article: Everything about Basic
Authentication deprecation in Microsoft Exchange online
(A-People login required).

Is the OAuth 2.0 feature backward-
compatible with any of the previous releases
of Automation 360?

No. The OAuth 2.0 feature is not backward-
compatible with previous Automation 360 releases.
Therefore, you are requested to manually update
the package released with Automation 360 v.25.

What are the steps involved to update my
impacted bots to switch to OAuth 2.0?

See to the following documentation page for the
steps to update your impacted bots and switching
from Basic authentication to OAuth 2.0: Deprecation
of Basic authentication in Exchange Online on page
792.

What are the different grant types or flows
supported for OAuth 2.0 in Automation 360?

In Automation 360, there are two primary grant
types that are supported for OAuth 2.0 across Email
package and Email trigger:
• Client credentials: Email package and Email

trigger
• Authorization code with PKCE: Email package

Within Email package, the individual Connect,
Send, Forward, and Reply actions support each
of these grant types as listed in the following table:

Action name Email Server
option

EWS option

Client
credentials

Client
credentials

Authorization
code with
PKCE

Authorization
code with
PKCE

— ROPC or Silent

Email >
Connect

— Implicit or
Interactive

— Client
credentials

Authorization
code with
PKCE

Authorization
code with
PKCE

Email > Send

— ROPC or Silent
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Action name Email Server
option

EWS option

— Implicit or
Interactive

Email >
Forward

Authorization
code with
PKCE

—

Email >
Reply

Authorization
code with
PKCE

—

Email Trigger Client
credentials

Client
credentials

Note:
• The existing Silent flow has been renamed as

ROPC (Resource Owner Password Credentials)
and the existing Interactive flow has been
renamed to Implicit.

• Both ROPC and Implicit grant flows are legacy
flows, less secure, and are not recommended by
Microsoft.

• The Client credentials flow for SMTP protocol is
currently not supported by Microsoft to access
Exchange Online.

• OAuth grant types
• Authentication flow support in MSAL
• OAuth 2.0 Client Credentials Flow support for POP

and IMAP protocols in Exchange Online

What will happen to my existing bots that
use email automation when I update to the
Automation 360 v.25 to update the default
version of the Email package or Email trigger
to the latest version?

When you update to the latest version of the Email
package or Email trigger, the existing bots that use
email automation will include the following changes:
• If your bots are using the Email server

option with IMAP or POP3 protocol, the
Authentication mode option will be set to
Basic by default to indicate that the action uses
Basic authentication.
If the Host field in the Email server option
uses a variable, the Authentication mode
option will be set to Basic.

• If your bots are using the EWS server option
with the Authentication mode option set to
Basic, there is no change in the bots.

Note:  This is the default scenario when you
update the Email package.
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• If your bots are using the EWS server option
with the Authentication mode option set to
OAuth2-Silent, the Authentication mode
option will be set to OAuth2 - ROPC to indicate
that the action uses the ROPC grant flow.

• If your bots are using the EWS server option
with the Authentication mode option set to
OAuth2-Interactive, the Authentication
mode option will be set to OAuth2 - Implicit
to indicate that the action uses the implicit grant
flow.

Why is the Send Email action marked as
Deprecated in my existing bots?

When you update your bots with the latest version
of the Email package, you will notice that the
Send Email action used in your bots are marked as
Deprecated due to the following reasons:
• We have created a new version of the Send

Email action which provides support for OAuth
2.0 mode of authentication.

• The new Send Email action is available in the
Email package version 3.14.1-20220831-084727
or later.

• The Deprecated message will help you
differentiate the old Send Email action from the
new Send Email action.

Note:  The Send Email action that is marked as
Deprecated will continue to work the same way as
earlier without any changes. However, if you want
to switch from Basic authentication to OAuth 2.0,
you must replace the deprecated Send Email action
with the new Send Email action and configure the
required OAuth 2.0 parameters.

Will Automation Anywhere provide any tool
for Automation 360 customers to update
their bots from Basic authentication to OAuth
2.0?

No. You will have to manually update your impacted
bots to switch to OAuth 2.0.

What is the guidance for Enterprise 11
customers if their bots are impacted by Basic
authentication deprecation?

Enterprise 11 customers are recommended to
migrate their Email automation bots to Automation
360 and leverage the OAuth 2.0 support. After
migration, you can perform the following:
• Upload the new version of the Email package or

Email trigger to Automation 360.
• Edit the impacted bots and set the latest version

of Email package or Email trigger as default.
• Manually update your bots by switching from

Basic authentication to OAuth 2.0.
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Note:  This guidance is applicable to both Cloud
and On-Premises customers who are migrating to
Automation 360.

Are there any limitations when you update
the Email package?

We recommend that you do not perform a bulk
update of bots to change Basic authentication to
OAuth 2.0. You must manually edit the bots and
update to OAuth 2.0.
Deprecation of Basic authentication in Exchange Online
on page 792

Scan Automation 360 bots for Email action with Basic authentication usage
Automatically identify Automation 360 bots that are using Basic authentication mode in the Connect, Send,
Forward, and Reply actions in the Email package and Email trigger, which are using IMAP, POP3, or EWS
protocols.
• Ensure that the user credentials used to connect to the Control Room has the View content

permission on the Bots folder.
The Bot Scanner utility connects to your Control Room using these credentials.

• Ensure that you meet the software and hardware requirements for using the Bot Scanner.
Consulta Scan Enterprise 11 or 10 bots using Bot Scanner on page 1160.

1. Download the Bot Scanner utility using the link provided in the following article: Everything about Basic
Authentication deprecation in Microsoft Exchange online (A-People login required).

2. Extract the files from the zip file that you have downloaded and double-click the
Automation_360_Bot_Scanner_For_EOL_Features.exe executable file to run the utility.
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3. In the Bot Scanner page, ensure that the Bots using Email action with Basic authentication
option is selected from the drop-down list, and then click Continue.

4. In the Automation 360 Bot Scanner EOL features page, perform these steps:
a) Enter the Control Room URL that you want to connect to
b) In base al tipo di autenticazione configurato nella tua Control Room, scegli uno dei seguenti

metodi di autenticazione nel campo Tipo di autenticazione:

Tipo di
autenticazione

Fasi

Active Directory 1. Inserisci il nome utente (dominio\\\nome utente).
2. Inserisci la password (password utente del

dominio).

Database 1. Inserisci il nome utente (nome utente del database
della Control Room).

2. Inserisci la password (password utente della Control
Room).
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Tipo di
autenticazione

Fasi

Single Sign-On 1. Immetti il nome utente.
2. Immetti la chiave API.

c) Fai clic su Verifica la connessione.
Viene visualizzato un messaggio di avvenuta connessione o di errore. Validate your credentials if
the connection fails.

d) Nel campo Seleziona il percorso di destinazione, immetti il percorso in cui desideri salvare il
rapporto generato.

e) Fai clic su Scansiona bot.

The scanner scans all the bots in your Control Room repository for Basic authentication mode usage in
the Connect, Send, Forward, and Reply actions in the Email package and Email trigger. After the
scan is complete, a report (.CSV file) is available in the destination path you selected for your review.
• If a .CSV file already exists in the output folder, a message is displayed that the previous .CSV file

will be deleted. When you click Continue, a new .CSV file is generated.
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• If the previous .CSV file is in use, a message is displayed that the file cannot be deleted. Close the
file and click Scan bots.

5. Click Open report to analyze the report.
Il rapporto contiene i seguenti dettagli:
• Nome TaskBot: Name of the TaskBot.
• Numero di riga: The line number of the Connect, Send, Forward, or Reply actions that are

using Basic authentication.
For Email trigger, the line number will be empty.

• Nome Package e action: The Email package and action that is using Basic authentication.
• Testo cercato: The hostname of the Email server or the domain name of the EWS server for the

respective action.
• Messaggio di azione e revisione: Use this information to understand the action that you have to

perform or the information that you have to review for the corresponding action containing Basic
authentication.
Consulta Basic authentication scanning messages on page 806.

• Percorso TaskBot: The path to the repository where the bot resides.

After you identify the bots that are impacted due to Basic authentication, you can plan to update these
bots in the Control Room repository to switch to OAuth 2.0 authentication. For more information on how to
switch to OAuth 2.0, see Deprecation of Basic authentication in Exchange Online on page 792.

Basic authentication scanning messages
The Bot Scanner report might display some messages for your review or action for updating bots that are
using Basic authentication to OAuth 2.0 in the Email package or Email trigger. Messages provide detailed
information about the action, error, or review required to update the bots.

Codice A1001

Messaggio The Basic authentication mode that is used to connect to the
email server is deprecated by Microsoft.

For the bot to run, update the authentication mode by
selecting OAuth 2.0 and configuring the required parameters.
Otherwise, a connection error will occur.

Codice A1002

Messaggio The Basic authentication mode that is used to connect to the
EWS server is deprecated by Microsoft.

For the bot to run, update the authentication mode by
selecting OAuth 2.0 and configuring the required parameters.
Otherwise, a connection error will occur.

Codice R1004
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Messaggio A variable is used in the 'Host' property of this bot.
If the variable is pointing to 'office365.com', this can
potentially have an impact on the action since the Basic
authentication mode that is used to connect to the email
server is deprecated by Microsoft.

You are advised to review the variable and update the
authentication mode by selecting OAuth 2.0 and configuring
the required parameters.

Chrome and Edge Manifest V3 extensions
As Google will deprecate Manifest V2 extensions , this might impact your existing automations that use
the current Manifest V2 extensions for Google Chrome and Microsoft Edge browsers. We have published
Manifest V3 extensions with the Automation 360 v.26 release to help you start switching to Manifest V3
extensions.

Manifest V2 based deprecation

A manifest is a specification that is used to build browser extensions. As Google is deprecating Manifest
V2 based extensions, we recommend that you update to Manifest V3 based extensions, which provides an
enhanced security, privacy, and performance.
Impact to our customers: Automations that use Google Chrome Manifest V2 based extensions will
stop working sometime after June 2023. The deprecation timelines of Manifest V2 based extensions are
currently under review and subject to change by Google.
• For Google Chrome Manifest V2 extensions timelines, see Manifest V2 support timeline.
• For Microsoft Edge Manifest V2 extensions timelines, see Overview and timelines for migrating to Manifest

V3.

Post the given date, you must switch to Manifest V3 extensions for your automations to work. You can
choose to use the enterprise group policy for both Google Chrome and Microsoft Edge to continue to use
Manifest V2 based extensions. For more information on Manifest extensions support and timelines, see,
Manifest V3 transition timeline.

Automation 360 features that use browser extensions

The following Automation 360 features use the Google Chrome or Microsoft Edge browser extension for
web applications running on Google Chrome or Microsoft Edge:
• Bot Agent device registration with the Control Room (uses Chrome extension only)
• Automation of web applications through Universal Recorder or Browser package
• User interface based triggers
• Packages that use window titles, for example, OCR and Mouse Click
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Plan the switch to Manifest V3 extensions

Note:  Manifest V3 extension is supported on Google Chrome and Microsoft Edge browsers version 91 and
later only.

Automation 360 customers: We have published new Google Chrome and
Microsoft Edge Manifest V3 extensions with the
Automation 360 v.26 release. We will also continue
to support Manifest V2 extensions until June
2023 to provide you time to switch to Manifest V3
extensions before Jan 2024 for Google Chrome. To
know about Microsoft Edge Manifest V2 extensions
timelines, see Overview and timelines for migrating to
Manifest V3.
You have the following options to switch to Manifest
V3 extensions:
• New customers: Users starting with

Automation 360 v.26 will directly use Manifest
V3 extensions. You will not be impacted by the
deprecation of Manifest V2 extensions.

• Cloud customers: Our Cloud deployments is
updated to Automation 360 v.26 in October, and
customers can switch to Manifest V3 extensions
when they update their Bot Agent.

• On-Premises customers:
• Updating to v.26: Customers updating from

an earlier version to Automation 360 v.26 will
switch to Manifest V3 extensions when they
update their Bot Agent.

• v.25: We have provided a Control Room
patch with Automation 360 v.25. After
installing the patch, the V2 extensions is
switched to Manifest V3 extensions when you
update the Bot Agent.

• v.24, v.23, and v.22: For customers on
Automation 360 v.24 or earlier, we strongly
recommend that you update to Automation
360 v.26 or later releases. If you choose not
to update, we will provide a set of steps to
perform on all Bot Agent and Bot Runner
devices to switch to Manifest V3 extensions.
Consulta Manifest extension manual upgrade.

• v.21 and earlier: We strongly recommend
that you update to the latest version of
Automation 360.

Note:  You can choose to delay switching
to MV3 extensions by using a Chrome group
policy that extends support for Manifest
V2 extensions until Jan 2024  for Google
Chrome, see Manifest V3 transition timeline.
To know about Microsoft Edge Manifest
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V2 extensions timelines, see Overview and
timelines for migrating to Manifest V3.

Customers migrating to Automation 360 We recommend that you migrate to Automation 360
v.26, which uses Manifest V3 extensions by default.
If you are migrating to Automation 360 v.25,
install the Control Room patch, that we released in
October.

Enterprise 11 customers Per informazioni, consulta Enterprise 11: Deprecation
of Basic authentication and MV2 extensions.

Extend Manifest V2 extensions usage through group policy

You can choose to use the enterprise group policy for both Google Chrome and Microsoft Edge to continue
to use Manifest V2 extensions till Jan 2024.
For information about Manifest V2 extension timelines for Google Chrome, see Manifest V3 transition
timeline. For Microsoft Edge, see Overview and timelines for migrating to Manifest V3.
You can extend the Manifest V2 deprecation only using the group policy. This extension provides you
adequate time to plan upgrading to Manifest V3 extensions. You can use any extension group policy to
extend the use of Manifest V2 extensions.
To update the policy, perform these steps:
1. Copy the following entries to a .txt file and save the file as a .reg file.

• Chrome:

Windows Registry Editor Version 5.00
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Google\Chrome
\ExtensionInstallForcelist]
"ExtensionSettings"="{\"kammdlphdfejlopponbapgpbgakimokm\":
{\"installation_mode\": \"normal_installed\",\"update_url\": \"http://
clients2.google.com/service/update2/crx\"}}"

• Edge:

Windows Registry Editor Version 5.00
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Edge
\ExtensionInstallForcelist]
"ExtensionSettings"="{\"dbmodiepejcigljbmeebedkmegndokbk\":
{\"installation_mode\": \"normal_installed\",\"update_url\": \"https://
edge.microsoft.com/extensionwebstorebase/v1/crx\"}}"

2. Run the .reg file.
3. Restart the browser for the changes to take effect.

Related concepts
Manifest V3 extensions FAQ on page 810
As Google will deprecate Manifest V2 extensions by June 2023, this might impact your existing automation
that use the current Manifest V2 extensions for Google Chrome and Microsoft Edge browsers.
Manually upgrade from Manifest V2 to V3 extensions for Chrome and Edge
Feature deprecations affecting Automation Anywhere products on page 759
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Review the features and capabilities (from Automation Anywhere or third party) that are deprecated or
nearing deprecation to understand how they affect your automation and what action is required.
Related tasks
Switch Manifest V3 to Manifest V2 extension manually on page 819
If you want to switch from Manifest V3 extension to Manifest V2 extension while remaining on Automation
360 v.26, you can manually switch to v2 extension.
Manage multiple browser profiles for Manifest V3 extension on page 817
Automation 360 v.26 automatically includes Manifest V3 extensions to support browser-based automation.
However, these V3 extensions in v.26 are by default for a single browser profile only.

Manifest V3 extensions FAQ
As Google will deprecate Manifest V2 extensions by June 2023, this might impact your existing automation
that use the current Manifest V2 extensions for Google Chrome and Microsoft Edge browsers.
We have published Manifest V3 extensions with the Automation 360 v.26 release to help you start
switching to Manifest V3 extensions.

What is Manifest V2 extension deprecation? A manifest is a specification using which browser
extensions are built. Google is deprecating Manifest
V2 extensions by June 2023 for Google Chrome.
To know about Microsoft Edge Manifest V2
extensions timelines, see Overview and timelines
for migrating to Manifest V3. The deprecation might
impact your existing automations that use Manifest
V2 extensions for Google Chrome and Microsoft
Edge browsers. So, we recommend that you plan
to switch to Manifest V3 extensions, which provide
enhanced security, privacy, and performance.
See the following resources for information on
Manifest V2 extensions deprecation timelines: :
• Google Chrome: Manifest V2 support timeline
• Microsoft Edge: Overview and timelines for

migrating to Manifest V3

When will the Manifest V2 support end? In June 2023, Manifest V2 extensions for Google
Chrome will stop functioning. You can update the
group policy for both Google Chrome and Microsoft
Edge to extend the use of Manifest V2 extensions
until Jan 2024 . For Microsoft Edge Manifest V2
extension timelines, see Overview and timelines for
migrating to Manifest V3 for more information.
Support for Manifest V2 for Google Chromeends in
Jan 2024 (see Manifest V3 transition timeline). To
know about Microsoft Edge Manifest V2 extensions
timelines, see Overview and timelines for migrating
to Manifest V3.You must switch to Manifest V3
based Google Chrome and Microsoft Edge browser
extensions by then.
To extend support for Manifest V2, see Extend
Manifest V2 extensions usage through group policy on
page 809.
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How do I know if I am going to be impacted
by the deprecation?

If you are using any or all of the following features
on Google Chrome or Microsoft Edge browsers, you
will be impacted by the Manifest V2 deprecation.
• Automation of web applications through

Universal Recorder or Browser package
• User interface based triggers
• Bot Agent device registration with the Control

Room
• Packages that use Browser variables, for

example, Recorder, OCR and Mouse Click

Do I have to do anything in advance of the
deprecation?

To avoid being affected by the deprecation, you can
choose one of the following options:
• Upgrade to Automation 360 v.26, which includes

the latest Manifest V3 extensions.
• Switch to Manifest V3 extensions before June

2023  if you are using Google Chrome. For
Microsoft Edge Manifest V2 extensions timelines,
see Overview and timelines for migrating to Manifest
V3. .

• Update the group policy to extend support for
Manifest V2 extensions.
Consulta Extend Manifest V2 extensions usage
through group policy on page 809.

What should I do to extend the group policy
to continue using Manifest V2 extensions?

You can use the group policy for both Google
Chrome and Microsoft Edge browsers to extend
support for Manifest V2 extensions. For more
information, see the following articles:
• Extend Manifest V2 extensions usage through group

policy on page 809
• Manifest V3 transition timeline
• Overview and timelines for migrating to Manifest V3

Will the Manifest V2 extensions be
automatically updated to V3 or do I have to
manually add V3 extensions to the browser?

• If you are on Automation 360 v.26 or later, and
if you have updated to Bot Agent 21.222 or later,
you will be automatically updated to Manifest
V3.

• If you are on Automation 360 v.25 and earlier,
you must manually upgrade the Manifest V2 to
V3. Consulta Manifest extension manual upgrade. .

Which Automation 360 versions are certified
for upgrading from Manifest V2 to V3
extensions?

The following versions are certified for the upgrade:
• v.25
• v.24
• v.23
• v.22
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I plan to continue with Automation 360 v.25,
so what should I do to continue using MV2
extensions?

You can continue to use Manifest V2 extension only
till Jan 2024  for Google Chrome (see Manifest V3
transition timeline). To know about Microsoft Edge
Manifest V2 extensions timelines, see Overview and
timelines for migrating to Manifest V3. You will have to
perform manual steps to extend the support.
Per ulteriori informazioni, consulta Extend Manifest
V2 extensions usage through group policy on page
809.

What about the automations that I have
already built using Chrome or Edge?

If your automations are dependent on browser
extensions, you must either upgrade to Manifest
V3 extensions or extend support for Manifest
V2 extensions for your automations to continue
working after the deprecation.

Do I need to update the Recorder package in
the bots or will they continue to work with
the earlier versions?

The Recorder package will work as intended, so
there is no need to update the package.

I am using Automation 360 Cloud, so will my
automations be impacted by the deprecation?

Cloud deployments are automatically updated to
the Automation 360 v.26 release, which includes
Manifest V3 extensions. The Bot Agent in v.26
refers to Manifest V3 extensions.

Note:  If the Automatically update all bot
agents option in your Control Room settings
is disabled on your device, you will not be
automatically updated to Manifest V3 extensions.
So ensure that this option is enabled to receive
automatic updates. Alternatively, you have to install
the Bot Agent manually on all the Bot Runner
devices.

How does the deprecation impact my
migration?

We recommend that you migrate to Automation 360
v.26, which uses Manifest V3 extensions by default.
If you are using Automation 360 v.25 or earlier, you
must either upgrade to Manifest V3 extensions or
extend Manifest V2 extensions before you migrate
browser-based automations.

Will the URL for the extensions change? Will
the URLs that I have added in the trusted list
for proxy settings be impacted?

Yes, the URLs for the extensions are different for
Manifest V2 and V3. Use the following URLs for
Manifest V3:
• Chrome: Google Chrome extension for Automation

360
• Edge: Microsoft Edge extension for Automation 360

Will Manifest V2 extensions be retained after
I upgrade to Manifest V3?

Until Jan 2024, you can continue to use the
extensions  for Google Chrome. To know about
Microsoft Edge Manifest V2 extensions timelines,
see Overview and timelines for migrating to Manifest
V3. However, these extensions cannot be modified
after December 2022, so Automation Anywhere
will not be able to make any updates to these
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extensions after December 2023. Also see, Manifest
V3 transition timeline.

Note:  If you are on Automation 360 v.26 release
and using Bot Agent 21.222, you will see both
Manifest V2 and Manifest V3 registry entries in the
Windows Registry.
• You can remove the Manifest V2 entry from

Windows Registry by uninstalling the existing
Bot Agent 21.222 and installing the Bot Agent
21.222 again.

• You can remove the Manifest V2 extension from
the Extensions page.

Uninstalling the Bot Agent will remove both
Manifest V2 and Manifest V3 extensions.
Uninstall or remove apps and programs in Windows

If Enterprise 11 and Automation 360 are
running on the same device , will there
be any conflicts due to the Manifest V2
deprecation?

There will be no impact in such scenarios because
the Manifest V3 extensions IDs are different for
Enterprise 11 and Automation 360.

As I am currently on Cloud deployment,
I'd prefer to continue using Manifest V2
extensions. Can I continue to use Manifest
V2?

We recommend that you upgrade to the latest
Automation 360 version to get the benefits of
Manifest V3 extensions. However, if you still want
to continue using Manifest V2 based extensions,
ensure that you disable the Automatically
update all bot agents option (in the Control
Room settings) for all devices and ensure that
users do not install the latest Bot Agent. This is
required because the Automation 360 v.26 Bot
Agent supports only Manifest V3 extensions.

Do I have an option to upgrade my devices in
a phased or staggered manner?

Yes, you can upgrade your devices in a staggered
manner to Manifest V3. You can disable the
Automatically update all bot agents option for
all devices and then select the devices individually
for which you want to upgrade the Bot Agent.

Can I continue to use Manifest V2 extensions
with the latest version of Automation 360?

Manifest V2 extensions are updated to Manifest
V3 extensions when you update Bot Agent to the
corresponding version of Automation 360 v.27.
Any existing configurations in the Manifest V2
extensions are overwritten.
Starting from Automation 360 v.26, Manifest
V3 extensions are bundled with the Bot Agent
installation. Therefore, Manifest V3 extensions
are installed when you update the Bot Agent. To
continue using the Manifest V2 extensions:
• Ensure that you do not update the Bot Agent.
• Select Disable auto updates option in Control

Room before updating your existing Automation
360 version.
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Consulta Aggiornamento automatico di Bot Agent on
page 1042.

Can I revert the upgrade from Manifest V3 to
V2?

Yes, you can switch from Manifest V3 to V2. Update
the JSON file with following Manifest V2 extension
IDs:
• Chrome V2 Extension ID:

kammdlphdfejlopponbapgpbgakimokm
• Edge V2 Extension ID:

dbmodiepejcigljbmeebedkmegndokbk

Per ulteriori informazioni, consulta Switch Manifest
V3 to Manifest V2 extension manually on page 819.

I had switched from Manifest V3 to V2
extensions for Automation 360 v.26. Can I
now update to Manifest V3 extensions when I
update Automation 360 to v.27?

When you update to Automation 360 v.27, the
corresponding Bot Agent is also updated. Manifest
V3 extensions are installed with the latest version of
Bot Agent.
Additionally, ensure that you select Enable
Automation 360 extension for this browser
profile option on Google Chrome and Microsoft
Edge browsers. Consulta Manage multiple browser
profiles for Manifest V3 extension on page 817.

Note:  If you are currently using Manifest V2
extensions or earlier versions, we recommend that
you update and use the Manifest V3 extension.

My bot uses a Recorder package from an
earlier Automation 360 version and has a
hard-coded Manifest V2 extension ID in it.
How do I change the extension ID?

When you update to Automation 360 v.26,
the extension ID for Manifest V3 is updated
automatically.

My application has IFrame with Content
Security Policy enabled. Will the Run
JavaScript action run the JavaScript inside
the IFrame?

With Manifest V3, Google has restricted access
to IFrame where Content Security Policy (CSP) is
enabled in target page. If your business application
does not have CSP enabled, you will be able to
run JavaScript inside the IFrame. If your business
application has CSP enabled, you will not be able
to run JavaScript inside the IFrame and the Run
JavaScript action will timeout or fail.

What version of the browsers are supported
for Manifest V3?

Manifest V3 is supported on Google Chrome and
Microsoft Edge Version 91 and later.

I am currently on Automation 360 v.26. Can I
switch to Manifest V2 extension?

Yes, you can switch to Manifest V2 extension
while being on Automation 360 v.26. Per ulteriori
informazioni, consulta Switch Manifest V3 to Manifest
V2 extension manually on page 819.

I am currently on Automation 360 v.26. Are
there any settings that I have to configure to
continue to avail the latest browser extension
versions?

If you have an internet connection, you will
continue to receive the updates through automatic
updates.

Can I use MV3 extension offline or without
internet connection?

MV3 extensions are automatically installed when
you update the Bot Agent to the latest version. MV3
based offline extensions are available for:
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• Google Chrome from Automation 360 v.26.
Consulta Install Chrome Plugin offline or without
internet access in Automation 360.

• Microsoft Edge from Automation 360 v.27.

For additional help, contact Automation Anywhere
support.

Will there be any impact to the remote agent
that I have been using?

The remote agent installed with Automation 360
v.25 or earlier is not compatible with the Manifest
V3 extension. You must install the latest Automation
Anywhere remote agent and use the latest Recorder
package.
Consulta Install Automation Anywhere remote agent
for Citrix 2.0: Recorder package version 2.8.6 on page
883.

What are the prerequisites to configure the
browser extension settings?

Following are the prerequisites to configure the
browser extension settings:
• Bot Agent version 21.222 or later.
• You must have installed the Bot Agent with

installation type as system-wide.

How to remove the Manifest V3 group policy? For Google Chrome: Navigate to
[HKEY_LOCAL_MACHINE\SOFTWARE
\Policies\Google\Chrome
\ExtensionInstallForcelist]
and remove the entries that contain
bboccnojhhoegfffpcllbeigipedjedf as the
extension ID.
For Microsoft Edge: Navigate to
[HKEY_LOCAL_MACHINE\SOFTWARE
\Policies\Microsoft\Edge
\ExtensionInstallForcelist]
and remove the entries that contain
fnmjcdajlonpigpcfnemeikipmolbfii as the
extension ID.
Restart the browser for the changes to take effect.

After updating to Automation 360 v.26, do I
have to disable Manifest V2 extensions?

When you upgrade to Automation 360 v.26,
Manifest V3 extensions is installed automatically,
without impacting the already installed Manifest V2
extensions. Both Manifest V2 and V3 extensions
can co-exist. The Manifest V2 extension does
not interfere with Manifest V2 extensions. You
can remove the Manifest V2-based extensions as
needed.

How to remove the MV2 extension? For Google Chrome: Navigate to
HKEY_LOCAL_MACHINE\SOFTWARE
\WOW6432Node\Google\Chrome\. Expand
Extensions folder and remove the folder by name
kammdlphdfejlopponbapgpbgakimokm.

© 2023 Automation Anywhere. All rights reserved.     815

https://apeople.automationanywhere.com/s/article/How-to-install-Chrome-Plugin-offline-or-without-internet-access-in-A2019
https://apeople.automationanywhere.com/s/article/How-to-install-Chrome-Plugin-offline-or-without-internet-access-in-A2019


    Automation Anywhere - Learn

For Microsoft Edge: Navigate to
HKEY_LOCAL_MACHINE\SOFTWARE
\WOW6432Node\Microsoft\Edge. Expand
Extensions folder and remove the folder by name
dbmodiepejcigljbmeebedkmegndokbk.
Alternatively, go to the Extensions page of your
respective browser and remove the entry related to
Manifest V2.

How to remove the MV3 extension? For Google Chrome: Navigate to
HKEY_LOCAL_MACHINE\SOFTWARE
\WOW6432Node\Google\Chrome\. Expand
Extensions folder and remove the folder by name
bboccnojhhoegfffpcllbeigipedjedf.
For Microsoft Edge: Navigate to
HKEY_LOCAL_MACHINE\SOFTWARE
\WOW6432Node\Microsoft\Edge. Expand
Extensions folder and remove the folder by name
bboccnojhhoegfffpcllbeigipedjedf.
Alternatively, go to the Extensions page of your
respective browser and remove the entry related to
Manifest V3.

How to force enable Google Chrome or
Microsoft Edge extension for user-specific Bot
agents?

You can force enable the Manifest V3 extension
on Google Chrome or Microsoft Edge by running
the .reg files for Manifest V3. Consulta Manifest
extension manual upgrade.

How to add an extension force group policy
if another extension policy has already been
added by my IT team?

If a key by name 1 is already present, create a key
name with the subsequent number, in this case, 2.
See the following articles:
• ExtensionInstallForcelist for Google Chrome
• ExtensionInstallForcelist for Microsoft Edge.

I have installed the latest Bot Agent and am
currently on Automation 360. However, I
ignored the browser extension pop-up dialog
box. What do I do?

If you updated the Bot Agent when you launched
a browser, you will be prompted to add or remove
the Manifest V3 extension with a pop-up dialog
box. To enable the Manifest V3 extension, you must
select the Add Extension option. If you ignore
the pop-up dialog box, the Manifest V3 extension
is disabled. To enable the extension and apply the
group policy, you must restart your browser.

How do I continue to use Manifest V2
extensions with Automation 360 v.26 and
later versions?

We recommend that you upgrade to the latest
Automation 360 version to get the benefits of
Manifest V3 extensions. However, if you still want
to continue using Manifest V2 based extensions,
ensure that you disable the Automatically
update all bot agents option (in the Control
Room settings) for all devices and ensure that
users do not install the latest Bot Agent. This is
required because the Automation 360 v.26 Bot
Agent supports only Manifest V3 extensions.
You can continue using Manifest V2 extensions until
for Google Chrome until Jan 2024 (see Manifest V3
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transition timeline). To know about Microsoft Edge
Manifest V2 extensions timelines, see Overview and
timelines for migrating to Manifest V3.

Related concepts
Chrome and Edge Manifest V3 extensions on page 807
As Google will deprecate Manifest V2 extensions , this might impact your existing automations that use
the current Manifest V2 extensions for Google Chrome and Microsoft Edge browsers. We have published
Manifest V3 extensions with the Automation 360 v.26 release to help you start switching to Manifest V3
extensions.
Manually upgrade from Manifest V2 to V3 extensions for Chrome and Edge
Feature deprecations affecting Automation Anywhere products on page 759
Review the features and capabilities (from Automation Anywhere or third party) that are deprecated or
nearing deprecation to understand how they affect your automation and what action is required.

Manage multiple browser profiles for Manifest V3 extension
Automation 360 v.26 automatically includes Manifest V3 extensions to support browser-based automation.
However, these V3 extensions in v.26 are by default for a single browser profile only.
You can enable browser extension for only one browser profile at a time. If you have multiple browser
profiles, you must enable browser extension only from the profile that is used to run the bots. You must
disable the Automation 360 browser extension from all other browser profiles. You also have the option to
debug logging, for troubleshooting purposes.

Note:  This procedure is applicable only if your browser is using Manifest V3 extension.

To enable or disable the browser extension individually for each browser profile, perform these steps:
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1. Open the Google Chrome or Microsoft Edge browser:
• On Microsoft Edge, navigate to Extensions > Automation 360 > Extension Options.
• On Google Chrome, navigate to chrome://extensions/ and select Details in Automation 360

and select Extension options.

The following page is displayed:

2. Select or deselect the Enable Automation 360 extension for this browser profile option.

Note:  When you enable this option, only the current active profile is used for communication with the
Bot Agent.

3. Select the Enable debug logging option to troubleshoot any browser extension issues.
4. Click Save and then restart the browser for the changes to take effect.
5. Verify that the debugging option is enabled for this browser profile by performing these steps:

a) Press F12 key or Ctrl+Shft+I keys on an active browser window.
b) In the Developer console, select the Application tab and then select Service Workers.
c) Click See all registrations.

In the Service Workers window, the extension ID in chrome://extensions and the ID in the
ServiceWorker window will be the same. Also, the Log field displays the logs continuously.

Related concepts
Manifest V3 extensions FAQ on page 810
As Google will deprecate Manifest V2 extensions by June 2023, this might impact your existing automation
that use the current Manifest V2 extensions for Google Chrome and Microsoft Edge browsers.
Manually upgrade from Manifest V2 to V3 extensions for Chrome and Edge
Related tasks
Switch Manifest V3 to Manifest V2 extension manually on page 819
If you want to switch from Manifest V3 extension to Manifest V2 extension while remaining on Automation
360 v.26, you can manually switch to v2 extension.
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Switch Manifest V3 to Manifest V2 extension manually
If you want to switch from Manifest V3 extension to Manifest V2 extension while remaining on Automation
360 v.26, you can manually switch to v2 extension.
To switch Manifest V3 extension to Manifest V2 extension manually, perform these steps:
1. Disable the Manifest V3 extension from the browser extension options.

Consulta Manage multiple browser profiles for Manifest V3 extension on page 817.
2. Edit the browser agent JSON file to replace the browser extension ID.

• Chrome
a. Navigate to C:\Program Files\Automation Anywhere\Bot Agent\AABrowserAgent

\.
b. Open the AAChromeAgentManifest.json file.
c. Replace the browser extension ID bboccnojhhoegfffpcllbeigipedjedf to

kammdlphdfejlopponbapgpbgakimokm.
d. Restart the browser for the changes to take effect.

• Edge
a. Navigate to C:\Program Files\Automation Anywhere\Bot Agent

\AABrowserAgent.
b. Open the AAEdgeAgentManifest.json file.
c. Replace the browser extension ID from fnmjcdajlonpigpcfnemeikipmolbfii to

dbmodiepejcigljbmeebedkmegndokbk.
d. Restart the browser for the changes to take effect.

Alternatively, download the JSON files from the link given below, and replace the files at the Bot
Agent installation location ( typically located at C:\Program Files\Automation Anywhere\Bot
 Agent\AABrowserAgent) on your Bot Agentmachines.
• For Chrome: Download the AAChromeAgentManifest.json from Google Chrome JSON file

download for Manifest V2.
• For Edge: Download the AAEdgeAgentManifest.json file from Microsoft Edge JSON file

download for Manifest V2.

If you have uninstalled the Manifest V2 extension manually, you must reinstall it from the Chrome web store.
Otherwise, your web-based automation might not continue to work.
If you are facing any issues, see Google Chrome extension troubleshooting on page 1960.
Related concepts
Manifest V3 extensions FAQ on page 810
As Google will deprecate Manifest V2 extensions by June 2023, this might impact your existing automation
that use the current Manifest V2 extensions for Google Chrome and Microsoft Edge browsers.
Chrome and Edge Manifest V3 extensions on page 807
As Google will deprecate Manifest V2 extensions , this might impact your existing automations that use
the current Manifest V2 extensions for Google Chrome and Microsoft Edge browsers. We have published
Manifest V3 extensions with the Automation 360 v.26 release to help you start switching to Manifest V3
extensions.
Manually upgrade from Manifest V2 to V3 extensions for Chrome and Edge
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Deprecation of Tesseract OCR v3
IQ Bot will permanently discontinue Tesseract OCR v3 starting from Automation 360 v.26. This affects
customers who have created learning instances using Tesseract OCR v3. We recommend that you plan
to train your learning instances with alternative OCRs (including Tesseract OCR) before you update to
Automation 360 v.26.
Removal of Tesseract OCR will affect the following product areas:
• My Learning Instances page:

For all Tesseract3 OCR learning instances, the Set the instance to Production button and Launch
Validator button are unavailable.
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• My Learning Instance details page:
• Select the Tesseract OCR v3 learning instance and go to the Learning Instance details page.
• The Set to staging, Add group, Validate, Edit, and Train buttons are unavailable.
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• Edit Bot page:
• In the My Learning Instance page, click the Edit bot button of any existing bot.

• The See extraction result, Save and close, Save and go to next group, and Delete Bot
buttons are unavailable.
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• Bot page:
• Go to Bot page.

• Click Test.

• The following error message is displayed:
The learning instance references OCR version which is not available -
Tesseract 3
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• There is no change in the Dashboard page, and it continues to show Tesseract 3 metrics.
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Installazione e aggiornamento Automation 360
Automation 360 fornisce una piattaforma RPA basata sul Web e nativa per il cloud per utenti di tutti i tipi.
Review the tasks involved in setting up Automation 360.

Legal disclaimer:  Le informazioni fornite in questo flusso di lavoro possono variare a seconda dell'offerta
utilizzata. Administrator steps might not be applicable to Cloud or Community Edition.

1. Scegli il modello di distribuzione di Automation 360.
Modelli di distribuzione alla pagina 15

2. Verifica i prerequisiti di sistema in base al modello di distribuzione:
• Cloud: Automation 360 Cloud prerequisites alla pagina 828
• On-Premises: Automation 360 On-Premises prerequisites alla pagina 840
• Community Edition: Introduzione a Community Edition alla pagina 1021

3. Amministratori: Configurazione degli utenti bot.
Utenti Bot, saltare questo passo e andare al passaggio 4.
a. Receive your administrator credentials.

• Amministratori Cloud: Ricevi le tue credenziali di accesso, con privilegi di amministratore e
il tuo URL Automation 360 dedicato da Automation Anywhere.

• Amministratori On-Premises: Receive your licensing information from Automation
Anywhere and install Automation 360.
The installation user is assigned administrator privileges.

Tipo di installazione Vai qui

Windows Installing Control Room On-Premises
alla pagina 838
Per visualizzare quest'attività di
installazione in un formato visivo
interattivo, consulta Install Control
Room On-Premises (custom mode).

Linux Installing Control Room on Linux alla
pagina 948

Amazon Web Services Installing Control Room on Amazon
Web Services alla pagina 926

Microsoft Azure Installing Control Room on Microsoft
Azure alla pagina 932
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Tipo di installazione Vai qui

Google Cloud Platform Installing Control Room on Google
Cloud Platform alla pagina 942

b. Accedi a un dispositivo supportato, apri un browser Web supportato e accedi a Control Room
utilizzando l'URL dedicato.
• Automation 360 Bot Runner device requirements alla pagina 829
• Accesso alla Automation Anywhere Control Room alla pagina 1022

c. Crea i tuoi utenti bot assegnandogli un ruolo e una licenza del dispositivo.
• Create a user alla pagina 2684
• Creazione di un utente Active Directory alla pagina 2686

d. Imposta le notifiche via e-mail agli utenti Control Room quando gli eventi li riguardano,
ad esempio modifiche alle password o alle informazioni dell'utente, nonché attivazione o
disattivazione dell'account.

4. Utenti di Bot: Esegui questi passaggi per iniziare con Automation 360.
a. Ricevi le credenziali di accesso utente e l'URL dedicato della Control Room.

Credentials are sent to you from your company's Automation Anywhere administrator or from
Automation Anywhere.
Utenti di Community Edition: Se non disponi di un account Automation 360, registrati con un
account Community Edition gratuito visitando Automation Anywhere Community Edition.

b. Log in to your Automation 360 account.
Accedi a un dispositivo supportato, apri un browser Web supportato e accedi alla Control Room.
• Automation 360 Bot Runner device requirements alla pagina 829
• Accesso alla Automation Anywhere Control Room alla pagina 1022

c. Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039.

Nota:  Bot Agent viene installato solo sui dispositivi che eseguono i sistemi operativi Windows
supportati. Consulta Automation 360 Bot Runner device requirements alla pagina 829. Puoi creare
bots utilizzando il Bot editor nella Control Room, ma per eseguire i bots è necessario installare Bot
Agent sul tuo dispositivo.

d. Inizia a creare bots:
• Creazione del primo bot alla pagina 1059
• Build a Go be Great bot alla pagina 2050

Update Automation 360:  Consulta Aggiornamento alla versione di Automation 360 più recente alla pagina
1063.
Cloud e Community Edition vengono aggiornati automaticamente.

Attività correlate
Accesso alla Automation Anywhere Control Room alla pagina 1022
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Per accedere a Automation 360, apri l'URL Control Room nel browser, immetti le credenziali nella
schermata di accesso e fai clic su Accedi.
Introduzione a Community Edition alla pagina 1021
Use these tasks to register for, and start creating and using bots with the Community Edition of Automation
360.
Riferimenti correlati
Automation 360 Bot Runner device requirements alla pagina 829
Review the machine hardware specifications, operating system versions, and browser types supported
for creating and running bots on a device. The same requirements are also valid for Automation 360
Community Edition.
Requisiti del browser per RPA Workspace alla pagina 866
Accedi all'interfaccia RPA Workspace da un browser. After you have installed and enabled extensions in
the browser, perform several tasks through the RPA Workspace interface based on your user role and
automation requirements.
Informazioni correlate
Install and update Automation 360 IQ Bot
Enterprise v11 Control Room installation
Enterprise v11 Client installation

Introduzione a Automation 360 Cloud
Utilizza queste attività per iniziare a creare e utilizzare i bots con Automation 360 Cloud.
1. Complete the prerequisites for Cloud.

Automation 360 Cloud prerequisites alla pagina 828
Utilizza l'elenco di controllo per determinare se il dispositivo soddisfa i requisiti per la registrazione con
Automation 360 Cloud.

2. Provision Cloud Control Room instances alla pagina 1014.
Use the Licenses and Cloud Services portal to provision Cloud Control Room and Cloud sandbox
Control Room instances on demand.

3. Receive your Control Room URL and login credentials. L'URL punta alla tua istanza Automation 360.
If you are your company's principal administrator and ordered cloud-deployed Automation 360, you
receive an email from Automation Anywhere with your URL and credentials.

4. Accesso alla Automation Anywhere Control Room alla pagina 1022.
Per accedere a Automation 360, apri l'URL Control Room nel browser, immetti le credenziali nella
schermata di accesso e fai clic su Accedi.

5. Install Bot Agent, register your device, and set user device credentials.
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039 | Set user device credentials alla
pagina 1052
The Bot Agent is a lightweight application that enables you to run bots on your device by connecting
the device to the Control Room. To run bots on a local machine, install the Bot Agent and add the local
device to the list of enabled host devices.
Per abilitare un dispositivo per l'esecuzione di bots, imposta le credenziali del dispositivo locale.
If you are using an operating system other than Windows, you will not be able to install the Bot Agent
at this time. Vedi requisiti di sistema. Tuttavia, è comunque possibile creare bots utilizzando Bot editor.
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6. Creazione del primo bot alla pagina 1059.
Segui questi passaggi per creare il primo bot che stampa il messaggio Go be great!, la versione
Automation Anywhere di Hello World!

7. Run your first bot alla pagina 1062.
Esegui un bot dallo stesso dispositivo utilizzato per creare il bot.

Video resources

• Introduction to Automation 360

• Installing the Bot Agent in Automation 360:

• Building your first bot:

• Running your first bot in the Community Edition:

Informazioni correlate
Cloud RPA

Automation 360 Cloud prerequisites
Utilizza l'elenco di controllo per determinare se il dispositivo soddisfa i requisiti per la registrazione con
Automation 360 Cloud.
• Verify the device software and hardware requirements.

Automation 360 Bot Runner device requirements alla pagina 829
• Access the Control Room URL from your browser.

Accesso alla Automation Anywhere Control Room alla pagina 1022
• Add the Automation Anywhere Domain Name System (DNS) to the safe recipients or allowed list to

ensure secure access to Automation 360 cloud services.
Add Automation 360 Cloud URLs to trusted list alla pagina 831

• Allow Automation Anywhere communications ports and protocols.
Allow Automation Anywhere communications ports alla pagina 834

• Add devices to the allowed list within the corporate network for granular security.
Add access IP addresses alla pagina 2735

• Add or update the authenticating proxy credentials to connect your device.
Connettere Bot Agent a un dispositivo con un proxy alla pagina 1046

• Set up SAML authentication identity provider if you are using single sign-on (SSO).
Configurazione dell'autenticazione SAML alla pagina 995

• Configure your network firewall to add the outbound NAT Gateway IP addresses to the allowed list.
Automation 360 IP addresses for external integrations alla pagina 2757

• Per la configurazione degli URL Control Room di dominio e sottodominio, segui le linee guida del
Domain Name System (DNS).
Naming guidelines for Control Room URLs alla pagina 977

© 2023 Automation Anywhere. All rights reserved.     828

https://www.automationanywhere.com/rpa/cloud-automation


    Automation Anywhere - Installazione e aggiornamento Automation 360

• To ensure seamless connectivity of your IQ Bot cloud servers with the Cloud Control Room, specify a list
or range of IP addresses that are allowed to access the Cloud Control Room URL.
Add IQ Bot cloud server IP addresses to allowed list alla pagina 835

Automation 360 Bot Runner device requirements
Review the machine hardware specifications, operating system versions, and browser types supported
for creating and running bots on a device. The same requirements are also valid for Automation 360
Community Edition.

Hardware requirements for registered devices

L'utente comunica con la Control Room attraverso una macchina locale registrata (dispositivo). Bot
Creators e Bot Runners utilizzano i dispositivi registrati per creare ed eseguire i bots. Part of registering a
device with Automation 360 is installing a Bot Agent.
The Bot Agent can be installed on devices that meet or are equivalent to the following hardware
requirements:

Dispositivo Processor RAM Storage (free disk
space)

Network

Macchina Intel Core i3 2.6
GHz with 4 multi-
cores or higher
64-bit

• 4 GB
(Minimum)

• 8 GB
(Recommended)

32 GB
Add 100 through
150 KB per
Automation
Anywhere script
Add 40 through 50
GB per long-term
project

• 5Mbps
(Minimum)

• 20Mbps
or higher
(Recommended)

Utenti aggiuntivi
su un dispositivo
multi-utente

2 CPU per
additional user

4 GB per
additional user

Non è richiesto
altro spazio di
archiviazione

Nessuna rete
aggiuntiva
necessaria

Additional RAM requirements for the
registered devices

Add additional RAM to account for applications
and services running on the registered devices, for
example:
• Applicazioni di Microsoft Office (esempio: Excel)
• Browser (esempio: Google Chrome)
• Applicazioni aziendali (esempio: CRM, Oracle

EBS e SAP
• VDI infrastructure applications
• Anti-virus software
• AISense Recorder

Additional disk space on registered devices • Automation 360 scripts average approximately
100-150 KB. Additional free disk space is
required to develop automation projects because
temporary files such as screenshots, server logs,
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and audit files are created during the execution
of the automation scripts.

• Free space required increases with the project
size. Recommendation: Have at least 40-50 GB
of free disk space for each long-term project.

• Increase storage space configuration after
installation, as needed, depending on product
usage. For example, depending upon the
complexity of your bot, generating log files and
logic creation require additional disk space later.

Additional CPU or processor on registered devices

AISense Recorder: Additional CPU or processor is required on a device if the existing CPUs are utilized
by customer applications. It is also required in case of a VDI infrastructure where CPU or processors are
shared across the infrastructure.

Platform compatibility for registered devices

A device used to connect to the Control Room and perform bot tasks must meet the platform
requirements.

Nota:  Platform requirements are different for Control Room and Bot Agent.

Registered devices Physical machines that you want to use for creating
bots or deploying bots and running any of the
supported operating systems.

Server di terminale Automation 360 versione A2019.11 o successiva
supporta l'utilizzo del desktop remoto (RDP)
che esegue uno qualsiasi dei sistemi operativi
supportati.

Macchine virtuali Bot Agent is supported on all VMs where the
supported Windows OS has been hosted on Version
A2019.09 or later. For example, Virtual Desktop
Infrastructure (VDI) are supported on Amazon Web
Services, Microsoft Azure, Google Cloud Platform,
VMware virtual machines, and Oracle Virtual Box.

Supported operating systems for registered devices
A device used to run the Bot Agent, connect to the Control Room, and perform bot tasks as a Bot Creator
and Bot Runner must meet the operating system requirements.

Nota:
• Only 64-bit operating system version supported.
• Le attività Bot Creator sono supportate con tutti i sistemi operativi elencati.
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• Non puoi registrare un dispositivo in esecuzione su un sistema Linux. Bot Agent non può essere
installato su sistemi Linux. Tuttavia, è possibile utilizzare un dispositivo registrato in esecuzione su un
sistema Windows per accedere a una Control Room installata su un sistema Linux.

Windows version Windows edition Bot Runner
assistito

Bot Runner non
assistito

Bot Creator

Windows Server
2019

Datacenter e
Standard

Supported Supportato1 Supported

Windows Server
2016

Datacenter e
Standard

Supported Supportato1 Supported

Windows Server
2012

Datacenter e
Standard

Supported Supportato1 Supported

Windows 11 Enterprise Supported Supportato1 Supported

Windows 10 Professional and
Enterprise

Supported Supportato1 Supported

Windows 8 2 Professional and
Enterprise

Supported Supported Supported

Windows 7 2 Professional and
Enterprise

Supported Supported Supported

(1) Auto-login • Auto-login is only supported on 64-bit systems.
• Se l'accesso automatico non riesce, configura le

impostazioni Criteri di sicurezza locali. For
example, in Windows, select Security Settings
> Local Policies > Security Options. Enable
the Interactive logon > Do not require
CTRL+ALT+DEL option.

(2) Supported OS Windows 11 (64-bit) supported on Automation 360
Build 15459 or later.
Windows 8 (64-bit) supported on Enterprise A2019
(Builds 1598 and 1610) or earlier.
Windows 7 (64 bit) supportato su Enterprise
A2019.12 o successiva.

Add Automation 360 Cloud URLs to trusted list
To ensure secure access to Automation 360 cloud services, add the URL specific to the service to the safe
recipients or trusted list.

Automation 360 Cloud URLs list

Automation 360 cloud service hosting uses dynamic IP addresses and therefore we recommend that you
add to the safe recipients list the complete URL instead of an IP address for the Automation Anywhere
cloud services.
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Servizio URL Porta Dispositivo

Automation Anywhere www.automationanywhere.comTCP 443 (HTTPS) Tutti i dispositivi

Automation Anywhere Cloud
customer tenant
Include Automation
Anywhere Control Room e
IQ Bot

crdomainname-
X.my.automationanywhere.digital

Nota:
• crdomainname-X si

riferisce al nome specifico
del tenant.

• The tenant name
does not support
the underscore ( _ )
character. So an
underscore is used in
the tenant name, the
specified URL will not be
created.

TCP 443 (HTTPS) Tutti i dispositivi
che accedono a
Automation 360

Automation Anywhere Bot
Agent download link

aai-
artifacts.my.automationanywhere.digital/

TCP 443 (HTTPS) Tutti i dispositivi
che accedono a
Automation 360

Automation Anywhere
community (A-People)

apeople.automationanywhere.comTCP 443 (HTTPS) Tutti i dispositivi

Automation Anywhere
documentation

docs.automationanywhere.comTCP 443 (HTTPS) Tutti i dispositivi

Bot Store botstore.automationanywhere.comTCP 443 (HTTPS) Tutti i dispositivi

Content delivery network
(CDN)
Consente alla piattaforma di
funzionare più rapidamente,
poiché distribuisce
geograficamente contenuti
statici comuni per i tenant
cloud.

aai-
artifacts.my.automationanywhere.digital

TCP 443 (HTTPS) Tutti i dispositivi
che accedono a
Automation 360

Telemetry
Consente di raccogliere
informazioni su prestazioni
e utilizzo in forma anonima
con l'intento di migliorare la
qualità del prodotto.

• cdn.pendo.io/
• app.pendo.io/
• data.pendo.io/
• https://pendo-

static-5673999629942784.storage.googleapis.com/

TCP 443 (HTTPS) Tutti i dispositivi
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Servizio URL Porta Dispositivo

Estensione Automation
Anywhere Google Chrome
Consente di automatizzare
l'utilizzo del browser Google
Chrome.

MV3 extension
https://
chrome.google.com/
webstore/detail/
automation-360/
bboccnojhhoegfffpcllbeigipedjedf

MV2 extension
https://
chrome.google.com/
webstore/detail/
automation-360/
kammdlphdfejlopponbapgpbgakimokm

TCP 443 (HTTPS) Dispositivi Bot
Creator e Bot
Runner

Estensione Automation
Anywhere Microsoft Edge
Consente di automatizzare
l'utilizzo del browser
Microsoft Edge.

MV3 extension
https://
microsoftedge.microsoft.com/
addons/detail/
automation-360-beta/
fnmjcdajlonpigpcfnemeikipmolbfii

MV2 extension
https://
microsoftedge.microsoft.com/
addons/detail/
automation-360/
dbmodiepejcigljbmeebedkmegndokbk

TCP 443 (HTTPS) Dispositivi Bot
Creator e Bot
Runner

Estensione Automation
Anywhere Mozilla Firefox
Consente di automatizzare
l'utilizzo del browser Mozilla
Firefox.

https://
addons.mozilla.org/
en-US/firefox/addon/
automation-360

TCP 443 (HTTPS) Dispositivi Bot
Creator e Bot
Runner

File e cartelle

For information on files and folders to add to the safe list and to the antivirus exception list, see these
articles:
• Files and URLs to add to safe list for Automation 360 (A-People login required)
• List of files to add to antivirus exception list for Automation 360 (A-People login required)

Attività correlate
Add access IP addresses alla pagina 2735
Use this setting to limit user login access to the Control Room URL based on IP addresses or subnets that
you specify in a list. You add IP address ranges using the Classless Inter-Domain Routing (CIDR) format,
and you can add multiple CIDR ranges.
Riferimenti correlati
Requisiti di porte, protocolli e firewall alla pagina 859
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Visualizza i requisiti predefiniti e configurabili di firewall, porta e protocollo per la distribuzione di
Automation Anywhere. View the default ports and protocols that are required to be allowed on customer's
firewall for Automation Anywhere deployment. The default ports that are used for HTTP/HTTPS are
configurable.
Add Automation 360 On-Premises URLs to trusted list alla pagina 974
To ensure secure access to Automation 360 online services for On-Premises deployment, add the URL
specific to the service to the safe recipients or trusted list.
Add IQ Bot cloud server IP addresses to allowed list alla pagina 835
To ensure seamless connectivity of your IQ Bot cloud servers with the Cloud Control Room, specify a list or
range of IP addresses that are allowed to access the Cloud Control Room URL.
Automation 360 IP addresses for external integrations alla pagina 2757
To ensure seamless connectivity of your Git instance, On-Premises key vault, or SIEM with the Cloud
Control Room, configure your network firewall to include Automation Anywhere outbound Automation 360
IP addresses to the allowed list.

Allow Automation Anywhere communications ports
As part of the Automation 360 Cloud prerequisites, you must allow Automation Anywhere communications
ports and protocols from the customer network.

Cloud communications ports

You can set the following connection modes between the customer network and the Control Room:
• Outbound: The traffic flows from the customer network to the Control Room.
• Inbound: The traffic flows from the Control Room to the customer network.

Nota:
• You do not need an inbound connection for a regular bot execution. The inbound connection is only

required when you have configured any integrations to: Git repository, On-Premises external key vault,
or SIEM server with your cloud-hosted Control Room.

• You must open the Cloud communications ports to unidirectional (outbound connection) to transmit
traffic from the customer network to the cloud-hosted Control Room.

The following table describes the required Cloud communications ports:

Automation 360 Cloud communications ports

Da A Porta Protocollo Tipo di
connessione

Bot Agent
(customer hosted)

Control Room
(Automation
Anywhere hosted)

443 HTTPS Outbound

Bot Agent
(customer hosted)

Control Room
(Automation
Anywhere hosted)

443 WebSocket Outbound

Access to Control
Room through
browser

Control Room
(Automation
Anywhere hosted)

443 HTTPS Outbound
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Automation 360 Cloud communications ports

Da A Porta Protocollo Tipo di
connessione

Control Room
(Automation
Anywhere hosted)
where Control
Room connects
from these
Automation 360
IP addresses
for external
integrations alla
pagina 2757

Third-party
Keystore
(customer hosted
and optional)

443 HTTPS Inbound

Control Room
(Automation
Anywhere hosted)
where Control
Room connects
from these
Automation 360
IP addresses
for external
integrations alla
pagina 2757

Git Repository
(customer hosted
and optional)

443 HTTPS Inbound

Control Room
(Automation
Anywhere hosted)
where Control
Room Room
connects from
these Automation
360 IP addresses
for external
integrations alla
pagina 2757

SIEM server
(customer hosted
and optional)

443 HTTPS Inbound

Add IQ Bot cloud server IP addresses to allowed list
To ensure seamless connectivity of your IQ Bot cloud servers with the Cloud Control Room, specify a list or
range of IP addresses that are allowed to access the Cloud Control Room URL.
Based on your region, add the following outbound NAT IP addresses to the allowed list in the Cloud Control
Room network settings:
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Regione IP addresses

- Africa • 13.244.57.44
• 13.244.197.159
• 13.244.185.72
• 54.228.5.1
• 54.228.48.30
• 54.217.103.248

- Australia • 54153153175
• 52.65.8.56
• 3.106.147.142

- Canada • 35.203.94.19
• 34.152.28.44

- EU West 1 • 108128188103
• 63.34.200.237
• 52.30.160.238
• 18.197.15.181
• 18.195.27.35
• 3.123.208.13

- EU West 4 • 35204101230
• 34141232185
• 34.141.55.27
• 34.141.57.227

India • 3.7.60.137
• 3.6.235.61
• 13.232.116.48
• 18.136.73.65
• 52.77.203.34
• 18.136.8.15

- Japan • 18177157130
• 18.176.174.19
• 3.114.196.205
• 54.169.202.27
• 52.221.25.42
• 18.140.96.19
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Regione IP addresses

- LATAM • 54.94.241.48
• 18.229.39.93
• 52.67.153.170
• 34.195.218.48
• 3.211.67.78
• 3.228.163.41

- Middle East • 15.185.153.52
• 15.185.181.122
• 157.175.32.98
• 52.213.112.204
• 54154112221
• 34.242.58.85

- Sandbox Australia • 34.151.71.179
• 35.189.24.10

- Sandbox EU West • 54.228.82.108
• 54.73.17.42
• 54.228.85.241
• 3.122.33.207
• 35.156.216.8
• 18.159.235.149

- Sandbox US West • 35164189142
• 35166154241
• 35.160.254.91
• 35.168.234.8
• 34.204.215.165
• 54.92.237.118

- Singapore • 18.141.71.43
• 54.251.139.55
• 18.136.253.184
• 18.176.165.62
• 52.68.115.49
• 54.168.135.182

- US Central • 34.85.131.101
• 35.245.151.203
• 34.68.252.217
• 34.123.71.95
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Regione IP addresses

- US East • 50.16.245.134
• 35.174.84.76
• 3.210.114.16
• 54.244.136.23
• 54.185.77.190
• 44.234.224.213

- US West • 54213119159
• 34.218.159.79
• 52.33.16.117
• 3.225.222.13
• 34.197.160.162
• 3.213.188.29

- Sandbox US Central • 35.223.219.53
• 34.133.80.165
• 34.150.165.212
• 35245150192

- Sandbox Singapore • 13251176239
• 54.169.33.175
• 46.137.201.87

Attività correlate
Add access IP addresses alla pagina 2735
Use this setting to limit user login access to the Control Room URL based on IP addresses or subnets that
you specify in a list. You add IP address ranges using the Classless Inter-Domain Routing (CIDR) format,
and you can add multiple CIDR ranges.
Riferimenti correlati
Add Automation 360 Cloud URLs to trusted list alla pagina 831
To ensure secure access to Automation 360 cloud services, add the URL specific to the service to the safe
recipients or trusted list.

Installing Control Room On-Premises
Review the installation core tasks and topics for installing the Automation 360 Control Room in a data
center on an On-Premises server or a cloud service provider server instance.
The Control Room provides centralized management for a digital workforce and an interface for Bot
Insight. It is deployed on a server in a data center.

Linux users:  See Installing Control Room on Linux alla pagina 948.

Nota:  Linux is not supported for Cloud-enabled On-Premises installations.
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Control Room installation core tasks

Prerequisites
Before you begin, download the appropriate installer for your operating system and version from A-People
Downloads page (Login required).

Step 1: Pre-installation Automation 360 On-
Premises prerequisites
alla pagina 840

Determine whether the
system has the required
hardware and software
to install Control Room
for On-Premises.

Step 2: Installation The Control Room installer allows you to select
installation modes (Express or Custom), and during
the installation process, it also installs missing
software dependencies.
Use Custom mode to install on a cloud-based
platform such as Amazon Web Services.

Installing Control Room
using Express mode alla
pagina 923

Log in to the servers
as an Administrator
and install Automation
Anywhere Control Room
in Express Mode using
the default settings.

Installing Control Room
using Custom mode alla
pagina 902

Log in to the server
as an administrator
and install Automation
Anywhere Control Room
in Custom mode to
select installation and
configuration options,
including installing non-
default requirements.
Select this mode for a
data center deployment.

Workflow map:  To
view this installation
task in an interactive
visual format, see
Install Control Room On-
Premises (custom mode).

Installing Control Room
on Microsoft Windows
Server using scripts alla
pagina 960

Silent Control Room
installation, also
known as unattended
installation, uses a
customized script for
a full setup or the
command line for a
hot fix patch. Silent
install runs the entire
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installation process
in the background
without requiring user
interaction or displaying
messages.

Step 3: Post-installation Configuring post-
installation settings alla
pagina 966

The options for
launching the Control
Room for the first time
and the authentication
method depend on the
installation mode and
deployment type.

Verifying Automation
Anywhere services alla
pagina 968

Automation Anywhere
specific services are
installed on the Control
Room server.

Step 4: Validation Configure Control Room
authentication options
alla pagina 980

The options for
launching the Control
Room for the first time
and the authentication
method depend on the
installation mode and
deployment type.

Automation 360 On-Premises prerequisites
Determina se il sistema dispone dell'hardware e del software necessari per installare la Control Room per
Automation 360 On-Premises.

Requisiti hardware

Control Room server requirements alla pagina 844 The Control Room is deployed on servers in data
centers. I requisiti hardware minimi di Automation
Anywhere includono: requisiti di tipo server, tipo di
computer, processore, RAM, archiviazione su disco e
rete.

Sistema operativo, ambiente e piattaforma supportati per
la Control Room alla pagina 850

Automation 360 can be hosted on AWS, Microsoft
Azure, Google Cloud Platform, IBM, and any public,
private, or hybrid cloud service that meets the
Control Room and Bot Agent hardware and software
requirements.

Compatibilità di Bot Agent alla pagina 1025 Bot Agent is the Automation 360 plug-in that
enables you to create and run bots. The agent is
installed on devices used to access the Control
Room. L'installazione di Bot Agent fa parte della
registrazione di un dispositivo.

Credential requirements alla pagina 853 Login credentials are required at different stages of
Automation Anywhere deployment and use. Sono
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necessarie credenziali per i server di installazione e
data center, per l'accesso a Automation Anywhere e
per eseguire strumenti nei bots.

Supported cloud platforms alla pagina 852 Esamina le piattaforme cloud supportate per le varie
funzionalità di Automation 360.

Data center requirements

Database requirements alla pagina 845 Working with SQL Servers
alla pagina 848

Configura i server
Microsoft SQL Server
prima di impostare il
database di Control
Room.

Working with Azure SQL
PaaS alla pagina 850

L'utilizzo del database
SQL PaaS con
Azure richiede la
configurazione
dall'istanza Azure.

Load balancer requirements alla pagina 857 View the load balancer requirements for Automation
Anywhere installation. Sono inclusi i requisiti
minimi del bilanciamento del carico e i requisiti di
bilanciamento del carico del livello TCP e HTTPS.

Requisiti di porte, protocolli e firewall alla pagina
859

Visualizza i requisiti predefiniti e configurabili di
firewall, porta e protocollo per la distribuzione di
Automation Anywhere.

Requisiti del browser per RPA Workspace alla pagina
866

L'interfaccia utente per Automation 360 (On-
Premises o Cloud distribuito) e per Community
Edition è accessibile tramite un browser.

Modelli di distribuzione HA e DR alla pagina 885 High availability
deployment alla pagina
891

Il modello di
distribuzione a
disponibilità elevata
(HA) fornisce una
tolleranza di errore
per i server Control
Room, i servizi e i
database utilizzando un
bilanciamento del carico
distribuito.

Disaster recovery
deployment alla pagina
892

The disaster recovery
(DR) deployment model
uses high availability
(HA) clusters distributed
across separate
geographic areas.

Single-node deployment
alla pagina 886

La distribuzione a nodo
singolo ospita la Control
Room solo su un server
o una macchina.
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Requisiti aggiuntivi

Configure application Transport Layer Security alla
pagina 907

Utilizza la pagina della procedura guidata
Configurazione di Transport Layer Security
(TLS) dal programma di installazione di Automation
360 per generare un certificato autofirmato o
importare un certificato di sicurezza per impostare
un'istanza di Control Room altamente sicura.

Naming guidelines for Control Room URLs alla
pagina 977

Per la configurazione degli URL Control Room di
dominio e sottodominio, segui le linee guida del
Domain Name System (DNS).

Consulta questo articolo anche sul sito di supporto Automation Anywhere: Automation 360 On-Premises
prerequisites (A-People login required).
Concetti correlati
Installing Control Room on Microsoft Azure alla pagina 932
Installing Control Room on Microsoft Azure begins in the Azure environment and ends with configurations
in the Control Room.
Installing Control Room on Amazon Web Services alla pagina 926
Log in to an Amazon Web Services (AWS) server instance as Administrator. Then, download and start the
Control Room installer and select Custom mode.
Installing Control Room using Custom mode alla pagina 902
Accedi al server come amministratore e installa Automation Anywhere Control Room in modalità
Personalizzazione per selezionare le opzioni di installazione e configurazione, inclusa l'installazione di
requisiti non predefiniti. Select this mode for a data center deployment.
Attività correlate
Installing Control Room using Express mode alla pagina 923
Installing Control Room on Microsoft Windows Server using scripts alla pagina 960
Silent Control Room installation, also known as unattended installation, uses a customized script for a full
setup or an update setup. Silent installation runs the entire installation process in the background, without
requiring user interaction or displaying messages.

Capacity and performance planning
To plan your deployment capacity and performance for Control Room On-Premises, understand the
requirements, limits, and defaults that determine the number of simultaneous bots, user sessions, and
processing rates.
The following topics provide information to help you calculate a deployment scenario that meets your
requirements.

Distribuzioni ed esecuzioni di bot concomitanti alla
pagina 842

To plan your deployment capacity and performance
for Control Room On-Premises, understand the
requirements, limits, and defaults that determine
the number of simultaneous bots, user sessions,
and processing rates.

Distribuzioni ed esecuzioni di bot concomitanti
Rivedi le informazioni sul numero massimo di distribuzioni ed esecuzioni simultanee per bot relative alla
distribuzione On-Premises.
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Panoramica

The entity count in the following list provides information only about the maximum number of entities
that the Control Room can support irrespective of the machine resources. Deploying additional machine
resources does not increase the entity count.
Control Room supporta una delle seguenti opzioni, per il numero massimo di distribuzioni ed esecuzioni di
bot concomitanti:
• 1.000 distribuzioni ed esecuzioni di bot concomitanti su sessioni Bot Runner (tipicamente in Control

Room di produzione)
• 700 distribuzioni ed esecuzioni di bot concomitanti su sessioni Bot Creator (tipicamente in Control Room

di sviluppo)

Tipo di entità Conteggio

Utenti 10.000*

Ruoli 5000*

Programmi 1500

Voci di audit 10.000.000*

Armadietti 100

Credenziali 5000

File dell’archivio
(compresi tutti i tipi di file nello spazio di lavoro
Control Room Pubblico)

Nota:  I file di archivio includono i file dipendenti
che si registrano nello spazio di lavoro Pubblico
(visibili sull'interfaccia utente) e i file correlati
dal database (non visibili sull'interfaccia
utente). Per esempio, i file .png generati
dopo la registrazione di un'automazione sono
memorizzati nel database e sono inclusi nei file
di archivio.

25.000*

Cartelle di archivio 9000*

Code 10

Pool di dispositivi 10

Work Items 1000000

* Applicabile da Automation 360 v.21 e versioni successive.

Distribuzioni ed esecuzioni concomitanti

Control Room supporta fino a 1.000 distribuzioni ed esecuzioni concomitanti di bot in tutto il cluster Control
Room. These 1000 bots can be a combination of the same or different bots.
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Nota:  If you use different bots, because of the load, the compiler slows down the execution for the first-
time deployment. For subsequent deployments, bot execution process might accelerate.

Edizione e configurazione di Control Room Numero di utenti Esegui come

Un'istanza di On-Premises Massimo 1.000

Tre istanze di On-Premises con configurazione
HA (High Availability)

Massimo 1.000

La distribuione di bot dipende dalla qualità della rete e dalla dimensione dei dati che devono essere
trasferiti da Control Room a Bot Agent.
Pertanto, nello scenario sopra, quando la velocità di connettività di rete aumenta per le tre istanze di
Control Room, il throughput di rete migliora e il tempo di completamento è più breve, ma il numero
massimo accettabile di distribuzioni concomitanti di bot rimarrà lo stesso.

Bot concomitanti programmati

Sono riportate le considerazioni sulla programmazione durante l'esecuzione ripetuta di bots.
Durante la configurazione di bots per eseguirli ripetutamente in un programma, è importante assicurarsi
che il tempo tra le sessioni non scenda al di sotto del tempo totale per la distribuzione e l'esecuzione
del bot. In caso contrario, le esecuzioni sequenziali del bot potrebbero sovrapporsi, portando a un
comportamento imprevisto.
Ad esempio, se occorrono 2 minuti per eseguire un bot, non programmare l'esecuzione del bot ogni 1
minuto. L'esecuzione precedente non può essere completata prima dell'inizio di quella successiva.
Con la specifica di riferimento è possibile configurare correttamente programmi concomitanti.

Attività Programma data

Programmi concomitanti 100

Utenti Esegui come per pianificazione 10

Totale bots concomitanti 1000

Control Room server requirements
La Control Room viene distribuita sui server nei data center. The minimum Automation Anywhere hardware
requirements include server type, machine type, processor, RAM, disk storage, and network requirements.

Nota:  Automation Anywhere non fornisce alcuna funzione di monitoraggio per l'archivio, ad esempio
l'utilizzo dello spazio su disco, la memoria o altri meccanismi di notifica correlati all'archivio. There are
commercial tools available from other third-party independent software vendors (ISV) who provide such
tools.

The installation wizard requires the following:
• Indirizzi IP: Identify all the nodes (servers) IP addresses in the data center cluster before installation.

You provide these IP addresses during Control Room installation.
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• Hardware di accesso: To enable viewing the Automation Anywhere interface, provide:
• keyboard
• mouse or other pointing device
• monitor with 1366 x 768 or higher resolution

Nota:  For IQ Bot server requirements, see IQ Bot hardware and software requirements .

La Control Room deve essere installata, con una sola istanza, su un computer a livello di server a 64 bit.
All previous Control Room versions must first be removed from the server machine before you begin the
installation.
Questi sono i requisiti del server per Windows e Linux.

Component
server

Processor RAM Storage
(free disk space)

Network

Control Room
Servers

Processore Intel
Xeon a 8 core
o processore
equivalente a 64
bit con velocità
superiore a 2,5
GHz

16 GB 500 GB 1 GbE
• IPv4
• IPv6

Utilizzo della memoria: Una Control Room configurata con i 16 GB di RAM raccomandati utilizza l'80-90
per cento della memoria in condizione di inattività e fino al 95 per cento della memoria sotto carico, ad
esempio per distribuzioni simultanee di bot.

Suggerimento:  Si raccomanda di configurare la larghezza di banda di rete della Control Room in modo
che sia superiore a 1 GbE per tutte le comunicazioni inter-cluster tra:
• Control Room and database
• All Control Room nodes
• Control Room and Elasticsearch nodes
• Control Room and storage systems
• Database nodes for high availability (HA) and disaster recovery (DR) configuration

Database requirements
Visualizzare l'elenco dei database supportati, il tipo di server di database, la versione, l'hardware e i
requisiti del sistema operativo, nonché i requisiti di backup e ripristino del database.
Automation Anywhere installation creates a database to store bot data and metadata for the analytics
dashboards.

Nota:  Automation Anywhere does not provide any monitoring functions for database activities, such as
disk space usage, memory, or other alert mechanisms related to databases. There are commercial tools
available from database vendors and other third-party independent software vendors (ISV) who provide
such tools.

For latest updates, see Microsoft SQL Server Hardware and Software requirements.
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Database server hardware requirements

Component
server

Processor RAM Storage Network

Database server Processore Intel
Xeon a 4 core con
velocità superiore
a 2,5 GHz

8 GB 500 GB 1 GbE

Nota:  Se ospiti database Control Room insieme ad altri database di applicazioni, assicurati di aumentare,
proporzionalmente le risorse hardware.

Database server version and operating system requirements

Tipo di
database

Versione
database

Edizione
database

Installed OS Piattaforme
supportate

Configuration
requirement

database di
Microsoft SQL
Server

2019
2017
2016
2014

Enterprise
Express
Standard
Sviluppatore
(per 2019)

Windows
Server
2008 R2
Standard or
later
Linux
CentOS 7.7
and 7.9
Red Hat
Enterprise
Linux 7.7
and 7.9

Amazon Web
Services
Relational
Database
Service (RDS)

Installed and
configured.
Only option
for Express
installations.
Enable
protocols for
Named Pipes
and TCP/IP.

database di
Oracle Server

Oracle 19c • Standard
• Enterprise

Windows
Server 2012
R2 or later
Linux
CentOS 7.7
and 7.9
Red Hat
Enterprise
Linux 7.7
and 7.9

Amazon Web
Services
Relational
Database
Service (RDS)

Installed and
configured
with
max_string_size
parameter set
to EXTENDED.
Supported
only on non-
container
Database.
Available only
through an
On-Premises
custom
installation.

• All database versions support all certified operating systems.
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• We have certified Amazon RDS for SQL Server and Azure SQL single database for PaaS deployment.
Note that for Azure SQL, CPU or memory requirements are not applicable because it is a scalable
and high performance Cloud database built on similar lines with SQL Server and certified for PaaS
deployment in Automation 360.

• Si consiglia di ospitare i database su host separati per tenere conto degli scenari di failover.
• We recommend Enterprise or Standard editions of Microsoft SQL Server database for production use

and to ensure business continuity with HA and DR deployments.
È possibile configurare l'edizione Express di Microsoft SQL Server per test e prove della validità
concettuale (POC) di Automation 360 in base a considerazioni quali il limite della dimensione dei dati,
l'indisponibilità dell'agente SQL e le capacità DR.
Per maggiori informazioni sui limiti di scala, vedere Microsoft SQL Server Express edition scale limits.

Required database information for Automation Anywhere installation

When you install Automation Anywhere, you are prompted to provide information specific to the database
type you are using. The following table summarizes the required information.

Microsoft SQL Server database

Informazioni richieste Descrizione

Fornire le credenziali per l'utente Microsoft SQL
Server con l'autorizzazione per connettersi al
database.
Use only supported characters for the
authentication user name and password.
Consulta Supported special characters alla pagina
874. Non utilizzare punti e virgola ( ; ) nella
password del database.

Database (SQL Server) authentication

Nota:  Linux installations use this authentication
method

Esempio Linux:
SQL Database server Login ID: sa
SQL Database password: Automation123
sa user authentication is mandatory.

Database names I nomi dei database non possono essere vuoti,
contenere spazi o includere ( % ). Limita i nomi
a caratteri alfanumerici, punto ( . ), trattino ( - )
e trattino basso ( _ ).
Default name: Automation360-Database

Porta di database Default: 1433
Connection to this port is mandatory.

Secure connection (optional) and certificate Provide a CA certificate. Ensure the certificate
host name and database connection are the
same.
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Microsoft SQL Server database

Informazioni richieste Descrizione

Credenziali di servizio Provide the user with db_datareader,
db_datawriter, and db_ddladmin
permissions to create databases during
installation.
The preferred method is to use the Domain user
account.

Autenticazione Windows Credenziali Windows dell'utente connesso al
dispositivo per la connessione al server del
database.

Database collation Use the default database collation:
SQL_Latin1_General_CP1_CI_AS

For Oracle Server database information, see Installing Control Room using custom mode for Oracle installation
alla pagina 901.
Before installing Automation 360, ensure that you have configured additional firewall settings, verified the
connection to the default port and an SQL query with SA user works as expected.
Concetti correlati
Installing Control Room on Amazon Web Services alla pagina 926
Log in to an Amazon Web Services (AWS) server instance as Administrator. Then, download and start the
Control Room installer and select Custom mode.
Installing Control Room on Microsoft Azure alla pagina 932
Installing Control Room on Microsoft Azure begins in the Azure environment and ends with configurations
in the Control Room.
Attività correlate
Installing Control Room on Linux alla pagina 948
You start installing the Automation Anywhere Control Room in the Linux environment and complete the
installation in the Control Room.
Configure default database port alla pagina 914
Configure and enable the TCP/IP in the SQL database server to use the default port 1433 when you install
the Control Room.
Riferimenti correlati
Requisiti di porte, protocolli e firewall alla pagina 859
Visualizza i requisiti predefiniti e configurabili di firewall, porta e protocollo per la distribuzione di
Automation Anywhere. View the default ports and protocols that are required to be allowed on customer's
firewall for Automation Anywhere deployment. The default ports that are used for HTTP/HTTPS are
configurable.

Working with SQL Servers
Configure Microsoft SQL Servers before setting up the Control Room database.
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Configuring SQL Server Settings

SQL Server settings can be configured in the SQL Server Configuration Manager.
1. Enable protocols for Named Pipes and TCP/IP in SQL Server Network Configuration > Protocols

for MSSQLSERVER.
2. Double-click TCP/IP to open the properties window.
3. Input the default or custom port number for IPAll in the IP Addresses tab of the TCP/IP Properties

window.
Il numero della porta predefinita è 1433.

4. Fai clic su OK.
5. Restart the MSSQLSERVICE for the updates to take effect.

Nota:  Ensure the Control Room database uses SQL_Latin1_General_CP1_CI_AS as the default
database collation.

Database and Services Matrix
See Database requirements alla pagina 845 for a list of supported Microsoft SQL Server versions.

Service Credentials Windows Authentication Autenticazione SQL

Local System Account • Current logged in user
account is used to create:
• Database
• Tabelle

• Installer gives db_owner
permission to NT
AUTHORITY\SYSTEM
account.

SQL User account is used to
create:
• Databases
• Tabelle

Domain User Account • Current logged in user
account is used to create
database.

• Domain user account is used
to create tables.

• Installer gives db_owner
permission to domain user
account.

SQL User account is used to
create:
• Databases
• Tabelle

Service User Account For Microsoft Azure
installations, the service
account user needs to have
read/write access to the remote
Microsoft Azure repository share
path.
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Riferimenti correlati
Requisiti di porte, protocolli e firewall alla pagina 859
Visualizza i requisiti predefiniti e configurabili di firewall, porta e protocollo per la distribuzione di
Automation Anywhere. View the default ports and protocols that are required to be allowed on customer's
firewall for Automation Anywhere deployment. The default ports that are used for HTTP/HTTPS are
configurable.

Working with Azure SQL PaaS
Using PaaS SQL database with Azure requires configuration from the Azure instance.
Configure the Azure instance before you install Automation 360.
1. Log in to your Azure account.
2. Navigate to the Azure SQL option.
3. Create a database based on your custom requirements.
4. Enable the firewall option.
5. Add the IP address to safe recipients list for accessing the database.

Install Automation 360 and point the database server to this instance of the SQL database. Consulta
Customize Control Room installation on Microsoft Azure alla pagina 936.

Sistema operativo, ambiente e piattaforma supportati per la Control Room
Automation 360 può essere ospitato su AWS, Microsoft Azure, Google Cloud Platform, IBM e su qualsiasi
servizio cloud pubblico, privato o ibrido che soddisfi i requisiti hardware e software per Control Room e Bot
Agent.
Automation 360 è attualmente certificato su AWS, Google Cloud Platform e Microsoft Azure. Per la
compatibilità del sistema operativo e della piattaforma Bot Agent, consulta le matrici di compatibilità
dell'Bot Agent in Compatibilità di Bot Agent alla pagina 1025.
Automation 360 supporta la versione a 64 bit del sistema operativo Microsoft.

Recommendation:  Abilita Desktop Experience quando utilizzi il sistema operativo server o client.

Nota:  When you install the Control Room on Microsoft Windows Server 2012 and 2012 R2 Datacenter, a
warning message indicating installation prerequisites is displayed. However, you can still proceed with the
installation without any issues.

Nota:  Before you install the Control Room for On-Premises, ensure that you have installed the Visual C+
+ Redistributable for Visual Studio 2015 package on the Control Room host machine. For more information
about the package, see Visual C++ Redistributable for Visual Studio 2015.

The following sections list the environment and deployment types with the release or build number
applicable to each supported operating system:

Data center 2012 e 2012 R2 Microsoft Windows Server

Ambiente Build (versione) Automation 360

• Amazon Web Services Elastic Compute Cloud
(EC2)

• On-Premises: Build 4105 (A2019.12) or later
• Cloud: Build 4111 (A2019.12) or later
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Ambiente Build (versione) Automation 360

• Microsoft Azure VM • On-Premises: Build 4105 (A2019.12) or later
• Cloud: Build 4111 (A2019.12) or later

• Google Compute Engine • On-Premises: Build 7103 (A2019.17) or later

Standard e data center 2016 Microsoft Windows Server

Microsoft Windows Server 2016 è il sistema operativo minimo consigliato.

Ambiente Tipo di distribuzione con versione e build

• Microsoft Azure VM • On-Premises: Build 2079 o successiva
• Cloud: Build 2079 o successiva

• Google Compute Engine • On-Premises: Build 7103 (A2019.17) or later

• VM VMware su ESXi 6.x • On-Premises: Build 7103 (A2019.17) or later
• Cloud: Build 2079 o successiva

Standard e data center 2019 Microsoft Windows Server

Ambiente Tipo di distribuzione con versione e build

• Amazon Web Services Elastic Compute Cloud
(EC2)

• On-Premises: Build 1089 o successiva
• Cloud: Build 1082 o successiva

• Google Compute Engine • On-Premises: Build 7103 (A2019.17) or later

• Microsoft Azure VM • On-Premises: Build 2079 o successiva
• Cloud: Build 2079 o successiva

Microsoft Windows 10

Ambiente Tipo di distribuzione con versione e build

• VM VMware su ESXi 6.x • On-Premises: Build 7103 (A2019.17) or later
• Cloud: Build 2079 o successiva
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Linux CentOS

Ambiente Tipo di distribuzione con versione e build

• Amazon Web Services Elastic Compute Cloud
(EC2)

Per Linux CentOS 7.7:
• On-Premises: Da Build 2545 o successiva
• Cloud: Da Build 2545 o successiva

Per Linux CentOS 7.9 e 8.3:
• On-Premises: Da Build 9664 o successiva
• Cloud: Da Build 9664 o successiva

Red Hat Enterprise Linux

Ambiente Tipo di distribuzione con versione e build

• Amazon Web Services Elastic Compute Cloud
(EC2)

Per Red Hat Enterprise Linux 7.7:
• On-Premises: Da Build 2545 o successiva
• Cloud: Da Build 2545 o successiva

Per Red Hat Enterprise Linux 7.9:
• On-Premises: Da Build 9664 o successiva
• Cloud: Da Build 9664 o successiva

Amazon Linux 2

Ambiente Tipo di distribuzione con versione e build

• Amazon Web Services Elastic Compute Cloud
(EC2)

Amazon Linux 2

Riferimenti correlati
Compatibilità di Bot Agent alla pagina 1025
Prima di installare Bot Agent, assicurati che sia compatibile con l'hardware e il software del tuo ambiente.
Control Room server requirements alla pagina 844
La Control Room viene distribuita sui server nei data center. The minimum Automation Anywhere hardware
requirements include server type, machine type, processor, RAM, disk storage, and network requirements.

Supported cloud platforms
Review the supported cloud platforms for various Automation 360 features.

© 2023 Automation Anywhere. All rights reserved.     852



    Automation Anywhere - Installazione e aggiornamento Automation 360

Automation 360 feature Google Cloud
Platform

AWS Microsoft Azure

Control Room Sì Sì Sì

Bot Agent Sì Sì Sì

Bot Insight Sì Sì Sì

IQ Bot Sì Sì Sì

Discovery Bot Sì Sì Sì

AISense Recorder Sì Sì Sì

Credential requirements
Login credentials are required at different stages of Automation 360 deployment and use. Credentials are
required for installation and data center servers, access to Automation 360 components, and to run tools in
bots.

Access point Attività Tipo

Data center servers Installare Control Room. User on the hosting server:
• Windows - system

 administrator
• Linux - superuser sudo,

root

Data center servers Manage (run, stop, restart)
Control Room.

Administrator and Logon
as Service permission for
Windows services and the
Domain or the VM technical
user account.

Bot Agent dispositivi Install, setup, or update Bot
Agent.

Administrator permission on the
device.

Bot Agent dispositivi Start or stop Bot Agent service. Administrator permission on the
device.
Write permission on Bot Agent
device system paths:
C:\ProgramData

C:\Windows
\System32\config
\systemprofile

C:\Users\<loggedInUser>
\AppData\Local
\AutomationAnywhere
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Access point Attività Tipo

Local devices Register device. Windows login to open a
browser and login into the
Control Room and register the
local device.
Administrator permission not
required.

Local devices Download bots to local device.
Run new bots or existing
(downloaded) bots.

Windows login.
Administrator permission not
required.

Automation 360 login Perform specific tasks, such as
create a bot or run a bot.

License and role based
permissions.
Bot Creator and Bot Runner
users do not require
administrator privileges.

Bot task Used by bots to perform bot
tasks.

Credential Vault stores securely
created credentials.
Read permission on bot
machine system path:
C:\Windows
\System32\config
\systemprofile

\AppData\Local
\AutomationAnywhere

Automation Anywhere Service Run all Windows services
created by Automation 360.

Local system account user or
Domain user account
The Interactive logon rights
should be enabled for the
service account.

Remote Desktop Protocol (RDP)
to a Windows machine

Run bots on Bot Creators and
unattended Bot Runners if
RDP connection exists for the
deployed user.

Administrator permission is not
required.
RDP access for the bot is not
required.
View the Control Room Activity
page.
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Access point Attività Tipo

Remote Desktop Protocol (RDP)
to a server OS or a hosted VM

Run bots on Bot Creators and
unattended Bot Runners if
RDP connection exists for the
deployed user.

Administrator permission
required.
RDP access for the bot is
required.
For confirmation, view the
Control Room Activity page.

Data center server credentials Data center server credentials for Automation
Anywhere hosting servers and integrated product
servers are required to deploy Automation 360.
To install and deploy Automation 360 requires
that users log in to the hosting servers. These
users must have permissions to install and run
Automation 360 components on the servers.
Permissions levels need to be assigned to the user
on selected data center applications and servers.

Automation 360 login Log in toAutomation 360 requires a username
and password. These credentials are linked to the
machine you use to access the Automation 360
components. Your credentials are assigned roles
that give you permission to perform specific tasks,
such as create a bot or run a bot.

Bot task As an automation expert, Credential Vault
provisions you to securely create and store your
credentials. This ensures that your credentials can
be used in bots without compromising security with
safe deployment of tasks. Any authorized user can
create credentials.

Windows services The Windows service credentials include a user
name and password. The user specified needs to
be:
• A member of the local system administrator

group.
• Have permission to manage services, including

Automation Anywhere services.
• If you use Windows authentication to connect

to the SQL database, ensure you grant the
db_owner permission to the service credential
user.

The service credentials are used to create database
tables and allow the Control Room processes to
access the database and repository.
The service credential choices are:
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User
role

Bot
program
folder

Bot
data
folder

Log
folders
or files

Tipo di
utente

Install
user

• Amministratore
• Non-

Admin

Service
run user

• Local
system
account

• Domain
user
account

Bot
deployment
user

• Letto
• Scrivi
• Elimina

• Letto
• Scrivi
• Elimina

• Letto
• Scrivi
• Elimina

• Local
system
account

• Domain
user
account

The following are the different user types:

Amministratore A user who has
administrator privileges.

Non-Admin A user who does not
have administrator
privileges.

Local system account The logged-on user
performing the
installation (default).

Domain user account A user that is not the
local system account
user.
Reasons and
requirements for using
a domain account user
include:
• Use the

Windows domain
credentials
Enter credentials
valid for running
Automation
Anywhere services.
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• PowerShell script
restrictions
Specify a user with
permissions to
launch PowerShell
scripts, who is not
a Windows domain
user, or database
table creation can
fail.

Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039

Load balancer requirements
Visualizza i requisiti del bilanciamento del carico per l'installazione di Automation 360. This includes load
balancer minimum requirements, and both TCP and HTTPS layer load balancing requirements.

Load balancer minimum requirements
As a best practice, ensure the load balancer:
• (Required) Adheres to the Domain Name System (DNS) guidelines when configuring the domain and

subdomain URLs in load balancer.
Naming guidelines for Control Room URLs alla pagina 977

• (Required) Supports WebSocket protocol (RFC 6455)
• (Preferred) Uses round-robin host selection and is not configured to use persistent (sticky) sessions.
• (Preferred) Uses the appropriate TLS security layer:

• TCP (layer 4) load balancing
• HTTPS (layer 7) load balancing

With a Nginx load balancer, set HTTPS termination at nodes by changing http://Backend to
https://Backend.

• (Preferred) Has idle timeout set to 120 seconds.
The timeout value depends on the process time of various actions in the Control Room such as the time
required to check in and check out bots, import bots, and download bot dependencies.
If the idle timeout is less than the Control Room processing time, a browser request can time out. For
example, if the configured idle timeout is not sufficient to complete a bot check-in action, you will have
to refresh your browser to validate whether the bot check-in action is successful or not.

Load balancer health check parameters

The load balancer health check parameters depend on various factors such as the type of load balancer
used, network latency, and user interface responsiveness within and outside the load balancer.
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TCP (Layer 4) Load Balancing

When TCP is applied at layer 4 with the load balancer, the certificate is installed on every Control Room
corresponding to the load balancer URL.

Nell'immagine,i componenti Control Room sono visualizzati in arancione e gli altri componenti sono
visualizzati in blu.

Vantaggi End-to-end encryption without the possibility of
intercept at the load balancer.
Single certificate required.

Svantaggi If audit logging is required, the load balancer
cannot report the requests from clients.
Does not use TLS hardware offloading, even if the
load balancer supports it.

HTTPS (Layer 7) Load balancing

When HTTPS is applied at layer 7 with the load balancer, the certificate corresponding to the load balancer
URL is applied through the load balancer. The Control Room trusts the certificates received from the load
balancer.
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Vantaggi Allows request logging, when supported by the load
balancer.
Reduces load from TLS handshake through
hardware offloading, when supported by the load
balancer.

Svantaggi I certificati vengono gestiti sia sul bilanciamento del
carico sia nei nodi della sala di controllo
Possible interception of data at the load balancer
hardware level, because TLS session is not end-to-
end.

For Automation 360 users on release Build 7560 and later, if SSL offloading is applied at load balancer level
for communication between load balancer and application nodes, the traefik.toml file in application
server needs to be re-configured.
See SSL offloading for Automation 360 v.18 and later (A-people login required) | A360 | Device shows disconnected
after registration with Load Balancer URL (A-People login required)

Requisiti di porte, protocolli e firewall
Visualizza i requisiti predefiniti e configurabili di firewall, porta e protocollo per la distribuzione di
Automation Anywhere. View the default ports and protocols that are required to be allowed on customer's
firewall for Automation Anywhere deployment. The default ports that are used for HTTP/HTTPS are
configurable.
• Aggiungi Automation Anywhere all'elenco di eccezioni di Windows Firewall. Attieniti alla procedura

indicata da Microsoft per la versione Windows in uso.
• Allow communication from Automation Anywhere by adding it to the allowed list in firewall. Follow the

steps in the firewall documentation of the operating system.
• Configura le regole del firewall e aggiungi gli URL della Control Room all'elenco dei destinatari sicuri.
• Configure the firewall rules to allow communication on the server or the firewall appliances that are

configured in between, or add the Control Room URLs to the safe recipients list in firewall or end device
browsers.
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Per gli elenchi delle porte richieste e il loro uso, fai riferimento alle tabelle riportate di seguito.

Control Room

Importante:  È fondamentale che la comunicazione tra i server di Control Room sia protetta
correttamente. The communication between Control Room servers contain security sensitive information.
Therefore, in addition to allowing all the required communication directly between the Control Room
cluster servers, you should block all the inbound traffic from hosts except for HTTP/HTTPS ports to
communicate with the Control Room servers.

Protocollo Porta Utilizzo Client

HTTP 80 HTTP Browser Web

HTTPS 443
HTTPS e
Web Socket

Browser Web

TCP/UDP 1234 ActiveMQ Servizi Automation 360

TCP 5672 Messaggistica cluster Servizi Automation 360

TCP 47100 - 47200
Messaggistica e
memorizzazione nella
cache del cluster

Servizi Automation 360

TCP 47500 - 47598
Messaggistica e
memorizzazione nella
cache del cluster

Servizi Automation 360

HTTP 47599 Elasticsearch Servizi Automation 360

TCP 47600 Elasticsearch Servizi Automation 360

HTTP 4567 Control Room Servizi Automation 360

HTTP 4569 - 4571 Automation Anywhere
Robotic Interface

Servizi Automation 360

TCP 5800 - 5900 Automation Anywhere
Robotic Interface

Servizi Automation 360

Porte interne per i servizi localhost

Le seguenti porte interne sono utilizzate per servizi localhost Automation 360:

Porta Protocollo

4567 - 4571 HTTPS REST

5678 - 5707 gRPC
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Porte e protocolli del data center per Automation 360

Configura tutti i componenti del data center necessari per l'integrazione della Control Room. Nell'immagine
che segue, i componenti Control Room sono visualizzati in arancione e i componenti del data center forniti
dalla tua organizzazione sono visualizzati in blu.

Nota:  The arrows in the image indicates the combination of communicating hosts and does not indicate
the direction of the establishing the connection.
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Le porte predefinite sono elencate a scopo illustrativo. Alcune porte possono avere numeri di porta
alternativi specificati durante l'installazione della Control Room. Alcuni numeri di porta possono essere
modificati dopo l'installazione della Control Room. Le porte di Active Directory sono elencate come esempio
di gestione delle identità aziendali.
After the HTTP/HTTPS connection is established between the Control Room and Bot Agent, the
communication will be bidirectional (inbound and outbound) using the WebSocket .
Tutti e tre gli oggetti, il browser web, Bot Agent e le applicazioni esterne comunicano direttamente con la
Control Room. L'utente accede a Control Room tramite un browser per eseguire attività quali la creazione
di utenti o attività correlate al bot come la creazione, la distribuzione e la pianificazione di bots. Bot Agent
stabilisce una connessione con Control Room al momento della registrazione e la mantiene attiva per
ricevere le distribuzioni di bot da Control Room. Le applicazioni esterne comunicano con la Control Room
direttamente tramite le API Control Room per eseguire attività quali la creazione di utenti o l'esecuzione di
bots.

Connection from Connection to Protocollo Porta Utilizzo

Bot Agent Load balancer or
firewall, or both

HTTP and
WebSocket

80 (TCP) Default HTTP and
WebSocket

Bot Agent Load balancer or
firewall, or both

HTTP and
WebSocket

443 (TCP) HTTP and
WebSocket

Web Browser Load balancer or
firewall, or both

HTTP and
WebSocket

80 (TCP) HTTP and
WebSocket

Web Browser Load balancer or
firewall, or both

HTTP and
WebSocket

443 (TCP) HTTP and
WebSocket

LDAP 389 (TCP) Autenticazione
utente

LDAP SSL 636 (TCP) Autenticazione
utente

LDAP global
controller

3268 (TCP) Autenticazione
utente

LDAP global
controller SSL

3269 (TCP) Autenticazione
utente

Control Room
services

Enterprise identity
management (for
example, Active
Directory)

Kerberos 88 (TCP and UDP) Autenticazione
utente

Control Room
services

File share with
Microsoft Server
Message Block
(SMB)

SMB 2.0 or SMB
3.0

445 (TCP) Repository file
share access

Control Room
services

Server database
Microsoft SQL

SQL 1433 (TCP)
Configurable

Database access
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Elementi del data center supportati Microsoft Azure

Oggetto data center Versioni supportate Configurazione

Sistema operativo Control Room • Data center 2012 e 2012 R2
Microsoft Windows Server

• Standard e data center 2016
Microsoft Windows Server

• Standard e data center 2019
Microsoft Windows Server

IaaS

Gestione delle identità: Azure
Active Directory

Azure Active Directory • IDaaS
• Windows 2016 per IaaS

SMB File Share Azure File Share con protocollo
Server Message Block 2.0 e 3.0
(SMB)

PaaS

Load Balancer Azure Load Balancer
(non Application Gateway)

PaaS

Microsoft SQL Server Database SQL di Azure con
database singolo (Microsoft SQL
Azure (RTM) - 12.0.2000.8)

PaaS

Porte consigliate per i criteri di sicurezza Microsoft Azure

Oggetto data center Porta Protocollo

Control Room • 80
• 443

HTTP/HTTPS

LDAP • 3268
• 3269

TCP (LDAPS - Secure TCP)

e-mail SMTP 587 SMTP

SSH 22 TCP

RDP 3389 TCP

Porte consigliate per i criteri di sicurezza Google Cloud Platform

Oggetto data center Porta Protocollo

Bilanciamento del carico • 80
• 443

• HTTP
• HTTPS
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Oggetto data center Porta Protocollo

Firewall • 80
• 443
• 1433

• HTTP
• HTTPS
• TCP

database di Microsoft SQL
Server

1433 TCP

Attività correlate
Prepare for installation on Amazon Web Services alla pagina 927
Effettua questi passaggi per preparare le istanze di Amazon Web Services (AWS) per l'installazione di
Control Room.
Verify readiness for installation on Microsoft Azure alla pagina 933
Use these steps to configure third-party products for the Control Room installation.
Riferimenti correlati
Automation 360 On-Premises prerequisites alla pagina 840
Determina se il sistema dispone dell'hardware e del software necessari per installare la Control Room per
Automation 360 On-Premises.
Add Automation 360 Cloud URLs to trusted list alla pagina 831
To ensure secure access to Automation 360 cloud services, add the URL specific to the service to the safe
recipients or trusted list.

Requisiti dell'archivio Control Room
La posizione dell'archivio viene configurata in Control Room dopo l'installazione. Tutte le automazioni
vengono memorizzate in questo archivio.
Prima di configurare l'archivio server Control Room, esamina i requisiti dell'archivio per la distribuzione di
Automation 360 On-Premises.
• Per la distribuzione a nodo singolo Control Room, l'archivio può essere una cartella locale.

Ad esempio, C:\Automation360\Automation Anywhere Server Files.
• Per una distribuzione Control Room a più nodi, l'archivio deve essere accessibile da tutti i nodi Control

Room del cluster sulla rete.
È possibile creare una condivisione di file e accedere all'archivio da un computer locale. Ad esempio, \
\<fileserver>\\<folder>\\Automation Anywhere Server Files.

The Control Room repository contains server files, such as packages and resource files.

Nota:  Deploying Distributed File System (DFS) as a Control Room repository is not supported.

Microsoft Windows: Requisiti dell'archivio Control Room

Esamina i seguenti requisiti per configurare la posizione dell'archivio dei nodi del cluster:
• The Control Room uses its service account to connect to the repository, you must have read/write

permission to the repository location.
• The repository path must meet the Universal Naming Convention (UNC) requirements.

Per informazioni, consulta UNC Path.
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• Le dimensioni dell'archivio dipendono dai dati dell'utente.
Per ulteriori informazioni sui requisiti di archiviazione, vedi Control Room server requirements alla
pagina 844. Per le dimensioni dei file e delle cartelle supportate, vedi Distribuzioni ed esecuzioni di bot
concomitanti alla pagina 842.
Per i requisiti di migrazione dell'archivio, contatta il rappresentante locale Automation Anywhere.

• You can configure the repository using Network File System (NFS) protocols, such as Microsoft
Windows, Microsoft Azure Files, and Amazon Elastic File System (EFS).

• Il NAS (Network-Attached Storage) utilizza Server Message Block versione 3 (SMBv3) per le piatteforme
supportate: Microsoft Windows, Amazon Web Services, Microsoft Azure, Google Cloud Platform e Linux.

Linux: Control Room configuration using the default repository path

• Ensure that the default path exists in the system and use this default path during the Linux installation.
After the installation, you can modify the repository path or copy files from one directory to another.
Verify that all copied files and folders have the same permissions as before the installation.

• Ensure that permission for the path is crkernel:controloroom.
• If there is no permission, add the following permission.

sudo chmod -R 775 /opt/automationanywhere/enterprise/appdata 

• Run the following command to allow users access to the crkernel:controloroom path:

sudo chown -R crkernel:controlroom /opt/automationanywhere/enterprise/
appdata

Linux: Control Room configuration with a user-defined repository path

• Ensure that the default path exists in the system.
• Ensure that permission for the path is crkernel:controloroom.
• If there is no permission, add the following permission.

sudo chmod -R 775 /CRRepo/AutomationAnywhere

• Run the command to allow users access the crkernel:controloroom path:

sudo chown -R crkernel:controlroom /CRRepo/AutomationAnywhere

The crkernel:controloroom user is created after the Control Room installation, so set the user
permission to a specified repository before performing the final Control Room configuration.

Requisiti del browser per RPA Workspace
Accedi all'interfaccia RPA Workspace da un browser. After you have installed and enabled extensions in
the browser, perform several tasks through the RPA Workspace interface based on your user role and
automation requirements.

Importante:  Microsoft Internet Explorer 11 terminerà il ciclo di vita (EOL) a giugno 2022, pertanto la
Control Room non sarà supportata sul browser Microsoft Internet Explorer 11 dalla prossima versione
Automation 360 v.25 prevista quest'anno (giugno 2022).
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L'impatto sulla tua automazione dipende dal sistema operativo attualmente utilizzato per le distribuzioni
bot. Fai riferimento alla tabella seguente per i dettagli.

Sistema operativo Microsoft Automation 360

Canale semestrale di Windows 10 Aggiorna i bots per utilizzare uno degli altri
browser compatibili.
Browser supportati

Tutti gli altri sistemi operativi supportati
Compatibilità di Bot Agent alla pagina 1025

Nono sono richieste azioni.

Per ulteriori informazioni, consulta Microsoft Internet Explorer 11 EOL FAQ alla pagina 770.

Browser supportati

È possibile utilizzare un browser per eseguire una serie di attività, dalla creazione dell'automazione alla
gestione dell'automazione, come quelle che seguono:
• Attività di Control Room, come creazione di utenti e ruoli, gestione dei dispositivi, configurazione delle

impostazioni, creazione e distribuzione di bots e mantenimento dei log di audit.
• Attività dell'utente, come l'installazione di Bot Agent e la registrazione del dispositivo.
• Attività Automation Anywhere Robotic Interface, come la creazione di utenti e ruoli e la creazione di

attività umane e bot nell'editor di processo.

Supporto del browser per Control Room e
Bot Agent e Automation Anywhere Robotic
Interface

La tabella che segue mostra i browser supportati
per le attività di Control Room, l'installazione di Bot
Agent, Automation Anywhere Robotic Interface e la
registrazione del dispositivo:

Attività Google
Chrome
(versione
57 o
successiva)

Internet
Explorer
(versione
11)

Microsoft
Edge
basato
su
Chromium
(versione
93.0.961.52
o
successiva)

Mozilla
Firefox
(versione
80 o
successiva)

Safari
(versione
15.3 o
successiva)

Attività
Control
Room

Sì No Sì No No

Installazione
di Bot
Agent
e
registrazione
del
dispositivo1

Sì No Sì3 Sì No
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Attività Google
Chrome
(versione
57 o
successiva)

Internet
Explorer
(versione
11)

Microsoft
Edge
basato
su
Chromium
(versione
93.0.961.52
o
successiva)

Mozilla
Firefox
(versione
80 o
successiva)

Safari
(versione
15.3 o
successiva)

Automation
Anywhere
remote
agent
for
Citrix

Sì2 Sì No No No

Automation
Anywhere
Robotic
Interface

Sì No Sì No Sì

Bot
Insight

Sì No Sì Sì No

1. Se hai problemi a registrare il tuo dispositivo
da un browser, esegui l'utilità di diagnostica Bot
Agent.
Per i dettagli, vedi Esecuzione di controlli
diagnostici Bot Agent alla pagina 1048

2. Automation Anywhere remote agent for
Citrix supporta l'automazione Google Chrome
(XenApp) con estensione Automation Anywhere
(versione 11.2.0.0).
Chrome web store

3. If you are using Microsoft Edge based on
Chromium to register your Bot Agent and
your device is unable to connect to the
Control Room due to proxy settings, add the
authentication details.

Supporto del browser per l'automazione della
registrazione

La tabella che segue mostra i browser supportati
per l'automazione della registrazione:
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Attività Google
Chrome
(versione
57 o
successiva)

Internet
Explorer
(versione
11)

Microsoft
Edge
basato
su
Chromium
(versione
79 o
successiva)

Mozilla
Firefox
(versione
80 o
successiva)

Microsoft
Edge
(Chromium)
con
compatibilità
Internet
Explorer
(versione
93.0.961.52
o
successiva)

Automazione
della
registrazione1

Sì
• L'estensione

deve
essere
abilitata
alla
registrazione.

• Supportato
da
A2019
v.10.

Sì
• Nessuna

estensione
richiesta
per
la
registrazione.

• Supportato
da
A2019.06.

Sì
• L'estensione

deve
essere
abilitata
alla
registrazione.

• Supportato
da
A2019
v.17.

Sì
• L'estensione

deve
essere
abilitata
alla
registrazione.

• Supportato
da
A2019
v.19.

Sì2

• Internet
Explorer
con
modalità
di
compatibilità
deve
essere
abilitato
per
la
registrazione.

• Supportato
da
Automation
360
v.23.

1. L'automazione della registrazione si riferisce
all'apertura di un'applicazione di destinazione
per la registrazione in un browser supportato e
alla registrazione di azioni o all'acquisizione di
oggetti con l'utilizzo di registratori Automation
Anywhere.
• Per i dettagli sull'automazione con

l'utilizzo di Universal Recorder e l'azione
di acquisizione Recorder, vedere Universal
Recorder for object-based automation alla
pagina 1949 | Edit a task recorded with the
Universal Recorder alla pagina 1952

• In caso di problemi con la registrazione
dell'automazione con Google Chrome,
vedere Google Chrome extension
troubleshooting alla pagina 1960

2. Microsoft Edge (Chromium) con la modalità di
compatibilità Internet Explorer è supportato per
acquisire oggetti da applicazioni web basate su
tecnologia HTML.

© 2023 Automation Anywhere. All rights reserved.     869



    Automation Anywhere - Installazione e aggiornamento Automation 360

Estensioni per l'automazione

Quando si installa il Bot Agent da un browser, vengono installate le estensioni per Automation 360. Le
estensioni sono necessarie per registrare l'automazione utilizzando un browser supportato.
È possibile abilitare le estensioni su un dispositivo dai browser supportati. Ad esempio, dopo aver installato
un Bot Agent da un browser Google Chrome, clicca sull'opzione Abilita estensione dalla barra delle
applicazioni del browser. L'estensione Google Chrome permetterà di registrare l'automazione utilizzando il
browser Google Chrome.
Quando si collega il dispositivo Bot Agent alla Control Room, è possibile abilitare le seguenti estensioni dal
browser per registrare l'automazione:

Nome estensione Collegamento all'estensione

Google Chrome Automation 360 extension for Chrome

Microsoft Edge basato su Chromium Automation 360 extension for Microsoft Edge

Mozilla Firefox Automation 360 extension for Mozilla Firefox

Per gli aggiornamenti alla versione più recente dell'estensione, vedere Browser extensions for Automation 360
alla pagina 718
Attività correlate
Esecuzione di controlli diagnostici Bot Agent alla pagina 1048
Usa l'utilità di diagnostica Bot Agent per problemi di connettività tra il dispositivo Bot Runner e Control
Room. L'utilità facilita la diagnosi dei problemi fornendo soluzioni o suggerimenti per facilitare la risoluzione
dei problemi.
Riferimenti correlati
Universal Recorder supported applications and browsers alla pagina 1958
Use the Universal Recorder to record interactions with objects from the supported technologies.
Compatibilità di Bot Agent alla pagina 1025
Prima di installare Bot Agent, assicurati che sia compatibile con l'hardware e il software del tuo ambiente.
Google Chrome extension troubleshooting alla pagina 1960
Se si verifica un errore durante la registrazione o l'esecuzione di un bot che automatizza le attività in un
browser Google Chrome e hai installato Google Chrome, devi eseguire ulteriori passaggi per configurare il
sistema.
Browser extensions for Automation 360 alla pagina 718
Crea automazione dai browser supportati utilizzando le estensioni del browser. Le estensioni sono
aggiornate periodicamente per supportare i miglioramenti e le correzioni delle funzionalità. Pertanto,
assicurati di disporre delle versioni più aggiornate delle estensioni per i browser Google Chrome, Microsoft
Edge e Mozilla Firefox.

Internazionalizzazione, localizzazione e supporto linguistico
Automation 360 fornisce supporto per l'internazionalizzazione e la localizzazione per l'interfaccia utente
(UI), l'automazione e la documentazione.
L'internazionalizzazione consente di automatizzare con l'utilizzo delle lingue supportate. La localizzazione
significa che le interfacce utente sono tradotte in lingue supportate da Automation Anywhere. Inoltre,
queste lingue supportate sono state testate e certificate per funzionare in quella lingua.

Internazionalizzazione Esegui l'automazione in varie lingue per lavorare
con sistemi operativi e tastiere localizzati.
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Formato di codifica UTF-8 è il formato di codifica predefinito per
Automation 360.

Documentazione prodotto Visualizza la documentazione Automation Anywhere
nella lingua supportata all'indirizzo https://
docs.automationanywhere.com/. Per visualizzare
le informazioni in una delle lingue supportate,
seleziona la lingua dal menu a discesa in alto a
destra del sito Web. La lingua predefinita è l'inglese
per qualsiasi argomento non disponibile in un'altra
lingua.

Interfaccia Visualizza l'interfaccia utente per i componenti
Automation 360, inclusi Control Room e IQ Bot,
nella lingua supportata.
• Consente di automatizzare le applicazioni (web e

desktop) con i valori di interfaccia utente, testo
e controlli della lingua (ad esempio, pulsante
con un nome della lingua e voci della casella
combinata nella lingua del testo).

• Fornisci il nome della lingua a un bot, flusso di
lavoro e report su Control Room.

• Fornisci il nome della lingua per le pianificazioni
di bot, il nome e la descrizione dell'automazione,
il nome e la descrizione del ruolo, il nome e il
cognome di un utente, i pool di carichi di lavoro
e le code.

• Distribuisci bots con il nome della lingua su Bot
Runners.

• Visualizza le entità della lingua (nomi,
descrizione e così via) in tutte le pagine in
Control Room.

Seleziona una lingua nell'interfaccia utente Dall'interfaccia di Control Room, accanto all'ID
utente, fai clic sull'icona della lingua (icona del
globo) e seleziona una lingua dall'elenco.

Le parti delle interfacce di Control Room tradotte non includono le applicazioni o gli strumenti utilizzati
all'interno di bots. Ad esempio, Microsoft Excel non viene tradotto tramite Control Room.

Automation 360

Nota:  L'impostazione della lingua di Control Room non traduce la lingua in Bot Insight a causa della
differenza nelle applicazioni. Per le lingue alternative in Bot Insight, gli utenti dovrebbero cercare la
traduzione dalle opzioni di lingua del browser o del sistema operativo configurati per la lingua da loro
scelta.

Lingua Internazionalizzazione
(sistema operativo e
set di caratteri)

Localizzazione
(interfaccia utente)

Documentazione
prodotto

Arabo Disponibile Non disponibile Non disponibile

Cinese (semplificato) Disponibile Disponibile Disponibile

© 2023 Automation Anywhere. All rights reserved.     871

https://docs.automationanywhere.com/
https://docs.automationanywhere.com/


    Automation Anywhere - Installazione e aggiornamento Automation 360

Lingua Internazionalizzazione
(sistema operativo e
set di caratteri)

Localizzazione
(interfaccia utente)

Documentazione
prodotto

Cinese (tradizionale) Disponibile Disponibile Disponibile

Danese Disponibile Non disponibile Non disponibile

Olandese (Paesi Bassi) Disponibile Non disponibile Non disponibile

Francese Disponibile Disponibile Disponibile

Tedesco Disponibile Disponibile Disponibile

Ebraico Disponibile Non disponibile Non disponibile

Ungherese Disponibile Non disponibile Non disponibile

Italiano Disponibile Disponibile Disponibile

Giapponese Disponibile Disponibile Disponibile

Coreano Disponibile Disponibile Disponibile

Polacco Disponibile Non disponibile Non disponibile

Portoghese (Brasile) Disponibile Disponibile Disponibile

Russo Disponibile Disponibile Disponibile

Spagnolo Disponibile Disponibile Disponibile

Svedese Disponibile Non disponibile Non disponibile

Turkish Disponibile Non disponibile Non disponibile

Automation 360 IQ Bot

Lingua Internazionalizzazione
(sistema operativo e
set di caratteri)

Localizzazione
(interfaccia utente)

Documentazione
prodotto

Arabo Disponibile Non disponibile Non disponibile

Cinese (semplificato e
tradizionale)

Disponibile Disponibile Disponibile

Francese Disponibile Disponibile Disponibile

Tedesco Disponibile Disponibile Disponibile

Italiano Disponibile Disponibile Disponibile

Giapponese Disponibile Disponibile Disponibile

Coreano Disponibile Disponibile Disponibile

Portoghese (Brasile) Disponibile Disponibile Disponibile

Russo Disponibile Disponibile Disponibile

Spagnolo Disponibile Disponibile Disponibile
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Components for Control Room and bot actions
Control Room and bots have additional requirements depending upon the Automation 360 deployment
model you choose. Some third party applications are installed with Automation 360.

Control Room supported platforms

View the listed supported platforms and components for Control Room.

Component Supported Control Room option

Amazon Web Services Elastic Compute Cloud
(EC2)

Necessario per installare la piattaforma Control
Room.

HTML Richiesto per Microsoft Azure: Use Load
Balancer, not Application Gateway.

Java Database Connectivity (JBDC) driver Richiesto per Oracle Database.

Linux CentOS or Red Hat Enterprise Linux Python 3.6 required for Build 6463 and later.
Install Control Room platform.

Microsoft Active Directory Da configurare come IDaaS o IaaS. For IaaS use
Windows 2016.

Microsoft Azure Necessario per installare la piattaforma Control
Room.

Third-party components for bot actions

View the listed third party components for the bot actions.

Component Automation 360 Plug-in Supported Bot action

ABBYY FineReader Engine
versione 12.2.27.12

Necessario per acquisire le
immagini nei pacchetti OCR,
AISense e IQ Bot.

Citrix Receiver
Version 4.4 LTSR or later

Nota:  You can also use the
Citrix Workspace app. All major
releases of the Citrix Workspace
app version .22 are certified.

Automation 360 Citrix remote
agent

Prerequisito per le azioni bot sul
Bot Agent installato sulle app
residenti Citrix.

Citrix Virtual Apps versione 6.5
o successiva

Automation 360 Citrix remote
agent

Prerequisito per le azioni bot
sulle applicazioni aziendali
ospitate da app residenti sul
server Citrix. Supportato con
Universal Recorder.

IBM WebSEAL For reverse proxy for Bot
Runner.
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Component Automation 360 Plug-in Supported Bot action

Microsoft .NET Framework
version 4.6.1 or later

For the Recorder package.

Supported special characters
Use only supported special characters when creating user names and passwords. Supported characters
vary depending upon where they are used.
In all of the below listed cases, the standard alphanumeric characters, a-z, A-Z, 0-9 are supported.
The special characters allowed or specifically excluded from particular use are typical to standard English
keyboards. See the table below to verify the special characters that can be used in names or passwords.

TLS certificate Do not use at sign ( @ ) in passwords
Wildcards The asterisk ( * ) is supported.
Windows Do not use the pipe ( | ) or semicolon ( ; ) in user

names or passwords.
Worksheet Do not use the asterisk ( * ), question mark ( ? ),

or bracket left or right ( [ ] ) in the worksheet
name.

Database Do not use percent ( % ) or space ( ) in the
database name.
Do not use semicolon ( ; ) in the database
username or password.

Supported characters

Characters supported for authentication are acceptable for both user names and passwords. In the table:
• Supported means the character is explicitly supported for that use.
• Do not use means the character is explicitly not supported for that use.
• Double dash (--) means results with using the character for that use are unknown.

Character Autenticazione
Windows

Control Room
authentication

Database name,
username, or
password

JSON Web Token
authentication

ampersand ( & ) Supported Supported -- Supported

angle bracket, left
or right ( < > )

Supported -- -- --

apostrophe,
straight single ( ' )

Supported -- -- --

asterisk ( * ) Supported -- -- --

at sign ( @ ) Supported Supported -- Supported

braces left or right
( { } )

Supported -- -- --
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Character Autenticazione
Windows

Control Room
authentication

Database name,
username, or
password

JSON Web Token
authentication

bracket left or
right ( [ ] )

Supported -- -- --

caret ( ^ ) Supported -- -- --

colon ( : ) Supported -- -- --

dollar sign ( $ ) Supported Supported -- Supported

equal sign ( = ) Supported -- -- --

exclamation point
( ! )

Supported Supported -- Supported

hyphen ( - ) Supported Supported Supported Supported

parenthesis, left or
right ( ( ) )

Supported -- -- --

percent ( % ) Supported Supported Do not use Supported

period ( . ) Supported Supported Supported Supported

pipe ( | ) Do not use -- -- --

plus sign ( + ) Supported -- -- --

number sign ( # ) Supported Supported -- Supported

question mark
( ? )

Supported -- -- --

semicolon ( ; ) Do not use -- Do not use --

slash, forward or
backward ( / \ )

Supported -- -- --

space Supported -- Do not use --

underscore ( _ ) Supported Supported Supported Supported

Citrix integration on Cloud
Automation 360 integration with Citrix enables you to create bots that run tasks on remote Citrix Virtual
Apps servers.

Process overview

Ensure the following tasks are completed before you begin automating tasks in a Citrix environment:

Verify the Citrix component version Following are the various Citrix components and
its related versions that are supported for the
Automation 360 integration with Citrix.

© 2023 Automation Anywhere. All rights reserved.     875



    Automation Anywhere - Installazione e aggiornamento Automation 360

Citrix
component
version

Automation
Anywhere
Plug-in

Automation
360 client or
Bot option

Citrix Receiver
Version 4.4
LTSR or later

Nota:  You
can also use
the Citrix
Workspace
app. All major
releases of
the Citrix
Workspace app
version .22 are
certified.

For using
Citrix server
resident apps
or installing
Automation
360 client.

Citrix Virtual
Apps versione
6.5 o
successiva

For using Citrix
server resident
apps.

Citrix
XenDesktop
Version 7.15
LTSR

Automation
Anywhere
Citrix plug-in
Automation
Anywhere
Citrix remote
agent

For using
Citrix server
resident apps
or installing
Automation
360 client.

Verify credentials and licensing • Ensure you have the credentials to access the
Citrix server.

Nota:  We recommend you have different Citrix
login credentials for each Bot Runner user.

• Ensure the appropriate Citrix license is available
for the Automation Anywhere Enterprise system.

Install components Specific Citrix and Automation Anywhere
components are required on both the local user
machine and the Citrix Virtual Apps server.

Local machine 1. Installare Citrix
Receiver.

2. Install the Bot
Agent. This is
automatically
installed when you
register the local
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machine with the
Control Room.
The Bot Agent
and Automation
Anywhere plug-
in for Citrix are
installed at the
same time if the
Citrix Receiver is
installed on the
local machine.

3. Install the
Automation
Anywhere plug-in
for Citrix.
If the Bot Agent is
already installed,
the Automation
Anywhere plug-
in for Citrix is
automatically
installed when the
Universal Recorder
is initiated.

Citrix server 1. Install the
Automation
Anywhere remote
agent for Citrix.

2. Register the
Automation
Anywhere remote
agent for Citrix as
a Virtual App in the
Citrix StoreFront.

Create a bot 1. From the Citrix StoreFront, run the
AARemoteAgent and the target application.

2. From the Control Room, create the bot, start
the Recorder, select the target application,
and record your actions on the Citrix server to
build your bot.

Using Citrix architecture with bots

To create and run bots using applications that reside on a Citrix server, see the following resources:

Using the Recorder on Citrix Virtual Apps servers alla
pagina 878

The Record: Capture cloning action requires
specific configurations to capture objects from
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applications available through the Citrix StoreFront
on a remote Citrix Virtual Apps server. Ensure the
required components are installed on the local
machine and the remote Citrix Virtual Apps server.

Concetti correlati
Installing Automation Anywhere remote agent on Citrix servers alla pagina 882
Install the Automation Anywhere remote agent on the Citrix Virtual Apps server where the virtualized
applications are installed.
Attività correlate
Using the Recorder on Citrix Virtual Apps servers alla pagina 878
The Record: Capture cloning action requires specific configurations to capture objects from applications
available through the Citrix StoreFront on a remote Citrix Virtual Apps server. Ensure the required
components are installed on the local machine and the remote Citrix Virtual Apps server.
Installing the Citrix required components on local machines alla pagina 881
Install the Automation Anywhere components to enable you to use bots on Citrix Virtual Apps servers. Two
components are installed: Bot Agent and Automation Anywhere plug-in for Citrix.
Riferimenti correlati
Requisiti del browser per RPA Workspace alla pagina 866
Accedi all'interfaccia RPA Workspace da un browser. After you have installed and enabled extensions in
the browser, perform several tasks through the RPA Workspace interface based on your user role and
automation requirements.

Using the Recorder on Citrix Virtual Apps servers
The Record: Capture cloning action requires specific configurations to capture objects from applications
available through the Citrix StoreFront on a remote Citrix Virtual Apps server. Ensure the required
components are installed on the local machine and the remote Citrix Virtual Apps server.
Complete the steps listed in the following tasks:
• Installing the Citrix required components on local machines alla pagina 881
• Installing Automation Anywhere remote agent on Citrix servers alla pagina 882

If you are using Google Chrome for automation, ensure the Automation Anywhere extension (version
11.2.0.0) for Automation Anywhere remote agent for Citrix is installed and enabled. For Automation 360
remote agent, ensure that the Automation Anywhere extension (version 3.0.0.0 or later) is installed and
enabled.
Chrome web store

Create bots with applications running on a remote Citrix Virtual Apps server using the Automation
Anywhere remote agent for Citrix.
1. Log in to the Citrix Virtual Apps server StoreFront.

Nota:  You can also use the Citrix Workspace app. All major releases of the Citrix Workspace app
version .22 are certified.
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2. Depending on the Automation 360 release, select and run one of the following remote agents from the
Citrix StoreFront.
• Select Citrix server > Citrix StoreFront > AARemoteAgent.

Nota:  AARemoteAgent is the Citrix name for the Automation Anywhere remote agent for Citrix.

• Select Citrix server > Citrix StoreFront > A360 Remote agent.

Nota:  A360 Remote agent is the Citrix name for the Automation 360 remote agent.

3. Run the target application from the Citrix StoreFront.
4. Log in to your registered local machine with the Bot Agent and Citrix Receiver installed.
5. Log in to the Control Room from your registered local machine.
6. Create a new bot or edit an existing bot.
7. Select the auto login feature to log in to a Citrix environment when it is locked or logged off.

Nota:  To ensure the auto login works, always log off the Citrix Receiver associated with the Citrix
Virtual Apps server before you disconnect.

8. Start the Recorder.
9. From the Automation Anywhere Record Application selection window, select the target

application from the drop-down list in the Window or URL field, and click Start recording.

Nota:  The remote application has \\Remote label at the end of the application name.

10. When the steps to record are completed, click End recording.

Concetti correlati
Citrix integration on Cloud alla pagina 875
Automation 360 integration with Citrix enables you to create bots that run tasks on remote Citrix Virtual
Apps servers.
Installing Automation Anywhere remote agent on Citrix servers alla pagina 882
Install the Automation Anywhere remote agent on the Citrix Virtual Apps server where the virtualized
applications are installed.
Attività correlate
Installing the Citrix required components on local machines alla pagina 881
Install the Automation Anywhere components to enable you to use bots on Citrix Virtual Apps servers. Two
components are installed: Bot Agent and Automation Anywhere plug-in for Citrix.
Riferimenti correlati
Requisiti del browser per RPA Workspace alla pagina 866
Accedi all'interfaccia RPA Workspace da un browser. After you have installed and enabled extensions in
the browser, perform several tasks through the RPA Workspace interface based on your user role and
automation requirements.

Using Citrix XenDesktop on Cloud
Install the Bot Agent on a Citrix XenDesktop virtual machine to create or run bots using applications that
reside on that Citrix XenDesktop virtual machine.
Ensure the required components are installed on the local Bot Agent machine and the remote Citrix server.
The required components are:

On the local machine Citrix Receiver: Install this on every machine you
use to connect to a Citrix server.
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Nota:  You can also use the Citrix Workspace app.
All major releases of the Citrix Workspace app
version .22 are certified.

On the Citrix XenDesktop Bot Agent: Install this on the Citrix XenDesktop
virtual desktop.
Log in to the Control Room and launch the recorder.
This triggers the Bot Agent installer.
The Citrix XenDesktop is a virtual machine sitting on
a remote Citrix server. It contains the applications
to be used for the bots.

The following figure shows the process flow when the Bot Agent is installed on a Citrix XenDesktop with
the applications on the virtual desktop.
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The Bot Agent can be installed on multiple platforms, which includes a Citrix XenDesktop virtual machine.
Ensure the virtual desktop meets the requirements for any Bot Agent installation.
Create bots with Citrix XenDesktop.
1. Prepare for bot activities.

a) Install the Citrix Receiver on your local machine.
b) Install the Bot Agent on Citrix XenDesktop.

2. From your local machine with Citrix Receiver installed, log in and open Citrix server > Citrix
StoreFront.

3. Select the Citrix XenDesktop virtual desktop with the Bot Agent.
The whole Citrix XenDesktop is presented as a local virtual desktop on your local machine. This is
automatic when you start the Citrix XenDesktop.

4. From the virtual desktop, launch the Enterprise Client that is installed on the Citrix XenDesktop, or
launch a browser and log in to the Control Room.

5. From your Control Room, create the bot.

Installing the Citrix required components on local machines
Install the Automation Anywhere components to enable you to use bots on Citrix Virtual Apps servers. Two
components are installed: Bot Agent and Automation Anywhere plug-in for Citrix.

1. Log in to your local machine.
2. Installare Citrix Receiver.

Nota:  You can also use the Citrix Workspace app. All major releases of the Citrix Workspace app
version .22 are certified.

This Citrix component is required to communicate from a local machine to a Citrix virtual application
server.
To install the Citrix Receiver, see the Citrix documentation.

3. Register your local machine with the Control Room. This installs the Bot Agent.
The Bot Agent enables local machine communication with the Control Room.
To install the Bot Agent:
a) Accedi alla Control Room tramite il tuo URL Automation Anywhere.
b) Navigate to Devices in the Manage tab.
c) From the action icons, click Add local bot agent.
d) Fai clic su Esegui la connessione al computer.
e) Segui i passaggi descritti nella procedura guidata.
f) Aggiorna la pagina Dispositivi e verifica che il dispositivo locale sia stato aggiunto.

4. Install Automation Anywhere plug-in for Citrix on your local machine.
The Automation Anywhere plug-in for Citrix provides the Citrix driver. This driver communicates with
the Citrix server.
To install the Automation Anywhere plug-in for Citrix:
a) Accedi a Control Room.
b) Launch one of the designated events.
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Designated events include: launch Recorder, use the Devices tab or Device Status tab, or run
a bot from Editor.

c) Opzionale: Verify that the Automation Anywhere plug-in for Citrix is installed.
Check for the file C:\Program Files (x86)\Citrix\ICA Client
\Automation.CitrixDriver.dll.

Concetti correlati
Citrix integration on Cloud alla pagina 875
Automation 360 integration with Citrix enables you to create bots that run tasks on remote Citrix Virtual
Apps servers.
Installing Automation Anywhere remote agent on Citrix servers alla pagina 882
Install the Automation Anywhere remote agent on the Citrix Virtual Apps server where the virtualized
applications are installed.
Attività correlate
Using the Recorder on Citrix Virtual Apps servers alla pagina 878
The Record: Capture cloning action requires specific configurations to capture objects from applications
available through the Citrix StoreFront on a remote Citrix Virtual Apps server. Ensure the required
components are installed on the local machine and the remote Citrix Virtual Apps server.

Installing Automation Anywhere remote agent on Citrix servers
Install the Automation Anywhere remote agent on the Citrix Virtual Apps server where the virtualized
applications are installed.
Based on the version of the Recorder package that you are using, choose the appropriate remote agent for
your environment:
• For bots that use 2.8.6-20220823-160834 version of the Recorder package, install the new Automation

Anywhere remote agent for Citrix 2.0 available with Build v 2.0.0.7. For details on installing the
Automation Anywhere remote agent for Citrix 2.0, see Install Automation Anywhere remote agent for Citrix
2.0: Recorder package version 2.8.6 alla pagina 883

• For bots that use 2.7.3-20220527-004608 or earlier version of the Recorder package, install the
Automation Anywhere remote agent for Citrix 1.0 available with Build v 1.0.0.0. For details on installing
the Automation Anywhere remote agent for Citrix 1.0, see Install Automation Anywhere remote agent for
Citrix 1.0: Recorder package version 2.7.3 and earlier alla pagina 884

Concetti correlati
Citrix integration on Cloud alla pagina 875
Automation 360 integration with Citrix enables you to create bots that run tasks on remote Citrix Virtual
Apps servers.
Attività correlate
Using the Recorder on Citrix Virtual Apps servers alla pagina 878
The Record: Capture cloning action requires specific configurations to capture objects from applications
available through the Citrix StoreFront on a remote Citrix Virtual Apps server. Ensure the required
components are installed on the local machine and the remote Citrix Virtual Apps server.
Installing the Citrix required components on local machines alla pagina 881
Install the Automation Anywhere components to enable you to use bots on Citrix Virtual Apps servers. Two
components are installed: Bot Agent and Automation Anywhere plug-in for Citrix.
Riferimenti correlati
Components for Control Room and bot actions alla pagina 873
Control Room and bots have additional requirements depending upon the Automation 360 deployment
model you choose. Some third party applications are installed with Automation 360.
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Install Automation Anywhere remote agent for Citrix 2.0: Recorder package version 2.8.6
Install the Automation Anywhere remote agent for Citrix 2.0 available with Build v 2.0.0.7 on the Citrix
Virtual Apps server where the virtual applications are installed.
Keep the following considerations in mind when automating a task in the Citrix environment using the new
Automation Anywhere remote agent for Citrix 2.0:
• If you are using Google Chrome for automation, ensure that the Automation Anywhere extension

(version 3.0.0.0 or later) for Automation 360 remote agent is installed and enabled.
Google Chrome extension for Automation 360

• Both Automation Anywhere remote agent for Citrix 1.0 and 2.0 can run on Citrix environment at the
same time.

• When you use the 2.8.6-20220823-160834 or later version of the Recorder package in your bots,
we strongly recommend that you use the Automation Anywhere remote agent for Citrix 2.0. If you
have not installed the Automation Anywhere remote agent for Citrix 2.0, then we have support for an
automatic fallback where the existing Automation Anywhere remote agent for Citrix 1.0 will be used.

Nota:  During fallback, the Automation Anywhere remote agent for Citrix 1.0 will work only with
technologies and browsers that it supports.

• For Citrix automation, bots created using the 2.8.6-20220823-160834 or later version of the Recorder
package will not work with the Automation Anywhere remote agent for Citrix 2.0 if you downgrade the
package to version 2.7.3-20220527-004608 of the Recorder.

• We strongly recommend that you avoid using both the new Automation Anywhere remote agent for
Citrix 2.0 and the Bot Agent installed over same Citrix environment because doing so can cause issues
with browser automation with either of the approaches.

• If you have bots that use 2.7.3-20220527-004608 or earlier version of the Recorder package, then the
bots will use the existing Automation Anywhere remote agent for Citrix 1.0.

• Automation 360 remote agent will not work if Citrix XenDesktop is also connected.
• Technology selection drop-down option for Recorder is not supported.
• Microsoft UI automation (COM) is not supported.
• SAP automation is not supported.

The following technologies and browsers are supported with Automation 360 remote agent for Citrix:
• Google Chrome
• Internet Explorer
• Microsoft Edge
• Microsoft Edge con modalità IE
• Mozilla Firefox
• Java
• Electron apps
• Microsoft Active Accessibility (MSAA)
• Microsoft UI automation

1. Log in to the Citrix Virtual Apps server.
2. Download the latest version of the Automation Anywhere remote agent for Citrix 2.0 installer file to

the Citrix Virtual Apps server. The Automation 360 remote agent running on the Citrix server interprets
data received from Automation 360 and responds appropriately.
a. Go to A-People Downloads page (Login required).
b. Select and download the Automation Anywhere remote agent for Citrix 2.0.
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3. Run the Automation Anywhere remote agent for Citrix 2.0 installer.
a. Extract the AARemoteAgent_2.0.zip file and double-click the A360RemoteAgent.exe file.
b. On the Automation 360 Remote agent Setup screen, click Next.
c. On the Select Destination Folder screen, click Browse to specify a non-default location for

installing the remote agent. Fai clic su Avanti.
The default location for installation is set to C:\Program Files (x86)\Automation
 Anywhere\A360 Remote Agent.

d. On the Setup Status screen, track the status of the installation process.
e. On the Setup Wizard Complete screen, click Finish to complete the setup.

4. From the Citrix interface, add the Automation Anywhere remote agent for Citrix 2.0 application to the
Citrix Delivery Controller.
This registers the Automation Anywhere remote agent for Citrix 2.0 as a Virtual App in the Citrix
StoreFront.

5. Verify that the Automation Anywhere remote agent for Citrix 2.0 is available from the Citrix StoreFront.
The Citrix StoreFront name for the Automation Anywhere remote agent for Citrix 2.0 remote agent is
A360 Remote agent.

Install Automation Anywhere remote agent for Citrix 1.0: Recorder package version 2.7.3 and earlier
Install the Automation Anywhere remote agent for Citrix 1.0 available with Build v 1.0.0.0 on the Citrix
Virtual Apps server where the virtualized applications are installed.
Keep the following considerations in mind when automating a task in the Citrix environment using the
Automation Anywhere remote agent for Citrix:
• If an application hosted on the Citrix environment runs in elevated mode, the Automation Anywhere

remote agent for Citrix must also run in elevated mode.
• If some applications hosted on the Citrix environment run in elevated mode and some on non-elevated

mode, you can install two instances of the Automation Anywhere remote agent for Citrix: One instance
of the agent will run in elevated mode and the other instance in non-elevated mode.

• If you are using Google Chrome for automation, ensure the Automation Anywhere extension (version
11.2.0.0) for Automation Anywhere remote agent for Citrix is installed and enabled.
Chrome web store

1. Log in to the Citrix Virtual Apps server.
2. Download the latest version of the Automation Anywhere remote agent for Citrix installer file to the

Citrix Virtual Apps server. The Automation Anywhere remote agent for Citrix running on the Citrix
server interprets data received from Automation 360 and responds appropriately.
a. Go to A-People Downloads page (Login required).
b. Select and download the Automation Anywhere remote agent for Citrix.
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3. Esegui il programma di installazione di Automation Anywhere remote agent for Citrix.
a. Extract the AARemoteAgent_1.0.zip file and double-click the

AAE_Remote_Agent_1.0.0.exe file.
b. On the Automation Anywhere Remote Agent Setup screen, click Next.
c. On the License Agreement screen, accept the license agreement, and click Next.
d. On the Select Destination Folder screen, click Browse to specify a non-default location for

installing the remote agent. Fai clic su Avanti.
The default location for installation is set to: C:\Program Files (X86)\Automation
 Anywhere\AARemoteAgent

e. On the Setup Status screen, track the status of the installation process.
f. On the Setup Wizard Complete screen, click Finish to complete the setup.

4. From the Citrix interface, add the Automation Anywhere remote agent for Citrix application to the
Citrix Delivery Controller.
This registers the Automation Anywhere remote agent for Citrix as a Virtual App in the Citrix
StoreFront.

5. Verify that the Automation Anywhere remote agent for Citrix is available from the Citrix StoreFront.
The Citrix StoreFront name for the Automation Anywhere remote agent for Citrix is AARemoteAgent.

Modelli di distribuzione HA e DR
Automation 360 provides several deployment options to meet various levels of enterprise cost/price
performance and resiliency requirements. The options include installation on single nodes and on multiple
nodes. Multi-node deployments can be configured for highly available (HA) clusters and disaster recovery
(DR) sites.
The deployment services are set up using the Automation 360 installer. A typical Automation 360 server
node runs the following services:
• Automation Anywhere Automation Services
• Automation Anywhere Messaging Services
• Automation Anywhere Caching Services
• Automation Anywhere Search Services
• Repository storage
• (Optional) IQ Bot VM

The Automation 360 installer also supports the multi-node deployment configuration.

Planning

Identify your requirements before selecting a deployment model. For best results, deploy the same
operating systems across the RPA Workspace development, testing, and production environments. At
minimum, have the same OS on both test and production environments.

Modelli di distribuzione

At a high level, there are two ways to deploy or install Automation 360 - single-node and multi-node.
Choose the option that meets your business continuity requirements.
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Single-node deployment

As the name suggests, there is a single physical server node, on which all the services related to
Automation 360 are run. By design, this configuration does not provide any redundancy and hence the
availability depends on the services on this single node.

Database In single-node deployment, the database can be
anywhere if the Control Room server is able to
connect to the database server. This can involve
network configurations.

Nota:  You cannot host the database server on
the same server as the Control Room server as it
requires higher processing/memory configuration on
the server.

Characteristics • No disaster recovery (single point of failure):
If the single node fails, RPA operation will be
adversely affected.

• No high availability: If the server is taken offline
for upgrade or maintenance, RPA operations will
be affected.

• No RPA up-scaling: When RPA deployments
scale up and users increase, the single node will
have to manage the increased load. This might
adversely affect the RPA performance.

Usage Recommendations Single-node deployments are typically
recommended for small-scale usage in proof of
concepts, demos, testing, and trials, to name a few.
Single-node deployments are NOT RECOMMEDED
for production usage because any downtime will
impair RPA operation and business continuity.

Advantages • Quick and easy installation and setup
• Additional servers not required
• Load balancers and clustering configuration not

required

The following image shows the Automation Anywhere and data center components for a single node. The
Automation Anywhere components are shown in orange and components provided by your organization
are shown in blue. Components that are centrally hosted on cloud and managed by Automation Anywhere
such as license server are shown in light orange.
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Multi-node deployment

To achieve higher processing scale, higher availability in production setups, Automation 360 services are
deployed across multiple server nodes. Installer enables you to setup multi-mode configuration. This
involves additional configuration steps such as linking services to same database and so on.

Distributed approach The Control Room provides the flexibility to process
large number of requests in given time window.
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Deploy multiple instances of Control Room on
multiple physical or virtual servers as required. This
also means configuring the cluster setup for the
caching, search, and messaging services.

Bilanciamento del carico Performed by a load balancer, this is the process
of distributing application or network traffic across
multiple servers to protect service activities,
allowing workloads to be distributed among
multiple servers. This ensures automation activity is
continued on clustered servers.
Load balancer requirements alla pagina 857

Databases In multi-node deployments, databases use their
own built-in failover to protect the data. Ciò
garantisce il recupero dei dati del database.
If you use cloud-based database services likes
of AWS-RDS, the High Availability and Disaster
Recovery as part of their service offerings, in
which case no further database configurations are
necessary.
For pure on-premises database scenarios, configure
synchronous replication between the primary
(active) and secondary (passive) clustered Microsoft
SQL Server in the data center. Ciò garantisce
la coerenza in caso di un errore del nodo del
database.
For synchronous replication, configure the database
using publisher and subscriber model in Microsoft
SQL Server from the primary disaster recovery site
to the secondary disaster recovery site that is at a
geographically separated location from the primary
site.
Replicate data between primary and secondary sites alla
pagina 899

L'immagine seguente mostra il Automation Anywhere e i componenti del data center per tre nodi in un
cluster di data center. The Automation Anywhere components are shown in orange and components
provided by your organization are shown in blue. Components that are centrally hosted on cloud and
managed by Automation Anywhere such as license server are shown in light orange.
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Importante:  Stretch clusters are not supported.
• Ensure that all the HA cluster nodes are configured in the same location. Do not configure the nodes in

a single HA cluster that is located across various sites. Ensure that you configure one HA cluster at the
primary site and the other HA cluster at the secondary site.
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• The Control Room and IQ Bot must be configured in the same data center to ensure communication
between both the applications.

Concetti correlati
High availability deployment alla pagina 891
To support Automation 360 in your data center, configure an high availability (HA) cluster. Follow your
company methods and procedures for implementing your data center cluster.

Convert single-node deployment to multi-node deployment
You can convert your single-node deployment into a multi-node deployment by editing the configuration
files and restoring the data in the repository for the single-node setup.
The single-node deployment can run on one of several infrastructures, local machines, private data
centers, and cloud providers.
To convert a single-node deployment running on AWS or other supported environment into a multi node-
deployment, perform the following steps.
1. In the Task Manager, stop all Automation Anywhere services.
2. Stop the Control Room instance.
3. Create an Amazon Machine Images (AMI) instance using the Control Room instance.

For information about how to create AMI in AWS, see Create an AMI from an Amazon EC2 Instance.
4. Create a new instance using the AMI created in the previous step.
5. Edit the configuration files related to the database server, Ignite cluster, and Elasticsearch to form the

clusters in the configuration directory on a standard installation.
The files are located in C:\Program Files\Automation Anywhere\Enterprise\config
a) Edit the database server URL to point to the intended database server in

boot.db.properties.
Do not change the URL if the original server already refers to a non-localhost address.

b) Edit the following property in the cluster.properties file:
Append the list with a new server IP in ignite.discovery.static.ips=<existing list
 of ips>, <current server ip>

c) Edit the following properties in the elasticsearch.yaml file:
• Add the current server address in node.name: "<local-ip>"
• Add the current server address in network.host: "local-ip"
• Leave the existing values intact and append the IP of the current server in

discovery.zen.ping.unicast.hosts: ["ip1","<local-ip>"]
• Leave the existing values intact in cluster.initial_master_nodes: ["<master-

ip>"]

6. Restore and mount the repository to the respective path from the same timed snapshot as the
selected Control Room snapshot.

7. Update the configuration tables to ensure TCP visibility between the nodes.
8. Start the services on the replicated node and wait for a couple of minutes for the clustering to

establish.
9. Log in to the Control Room to verify whether the bots are available and the repository structure is

intact.
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10. Check Git integration for standard installations.
If the installation has external Git configured, check the validity by exercising test check-in and
confirm audit logs.

High availability deployment
To support Automation 360 in your data center, configure an high availability (HA) cluster. Follow your
company methods and procedures for implementing your data center cluster.

Why only odd number of nodes are supported A cluster comprising even number of nodes can
merge inconsistencies but can result in a split-brain
condition where the cluster has no majority and
cannot resolve transactions, which might result in
data inconsistencies. La condizione di split-brain è
una limitazione nota dei sistemi di clustering che
può essere causata da problemi di rete, inclusa la
latenza.
Deployment configurations with odd numbered
nodes can help avoid split-brain issues and are
recommended for Automation 360 deployments.

Quorum The nodes determine which transaction can be
processed through voting on each transaction.
The number of votes constituting a majority of the
nodes in the cluster is referred to as a quorum and
determines how many nodes have to vote for or
confirm a transaction before it can be processed.

Fault Tolerance Fault tolerance in terms of node failure is
determined by how many nodes can fail before
a quorum or majority of nodes is not available
to vote on the validity of any transaction. Fault
tolerance is optimized with an odd number of nodes
in the cluster because a majority in odd-numbered
clusters is a lower number than in even-numbered
clusters

Supported Configurations A cluster with three or higher odd number of nodes
prevents the split-brain condition or inconsistencies
due to network issues, while giving the higher scale
and availability.

Number of
nodes in
cluster

Majority
(quorum)

Fault
tolerance
(node
failures)

Supporto

3 2 1 Certified

5 3 2 Contact
Automation
Anywhere
support
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Number of
nodes in
cluster

Majority
(quorum)

Fault
tolerance
(node
failures)

Supporto

7 and so
on

4 and so
on

3 and so
on

Contact
Automation
Anywhere
support

Multi-availability Zone/Multi-datacenter
Configurations

When going for a multi-zone deployment in
further enhance the availability, say with 3 nodes
deployment, we recommend that you have each
Control Room in separate availability zones.
Deployments with more than 3 nodes, spread these
deployments across at least 3 availability zones.
One thing we need to be concerned about in these
setups is the latency between the zones/providers.
The nodes in a high availability cluster must be
deployed in the same region.
In terms of the cloud providers, we currently
support 3 major cloud providers - Amazon Web
Services, Google Cloud Platform, and Microsoft
Azure.

Nota:  In a multi-node environment, if a node goes down, operations such as bot deployments and
schedules, triggers, and work items in queues on that node will be adversely affected.

Suggerimento:  For information on how to backup and restore files to recover a Control Room High
Availability cluster in case of failure, see Backing up and restoring a Control Room High Availability Cluster (A-
People login required).

Concetti correlati
Disaster recovery deployment alla pagina 892
Il modello di distribuzione con ripristino di emergenza (Disaster Recovery, DR) utilizza cluster a disponibilità
elevata (High Availability, HA) distribuiti su aree geografiche separate.
Attività correlate
Configura cluster IP alla pagina 917
Use the Cluster Configuration wizard page under Custom installation type in Control Room installer
to configure resiliency requirements. Select the Enable Cluster setup option and for high availability
cluster, provide multiple (three or more) IP addresses from your cluster setup.
Configure disaster recovery site for Elasticsearch IP addresses alla pagina 972
If you have configured the Control Room for high availability (HA) and disaster recovery (DR) and installed
the Control Room on both the primary and secondary sites, configure Elasticsearch IP addresses for the
secondary site.
Informazioni correlate
Cluster coordination in ElasticSearch

Disaster recovery deployment
Il modello di distribuzione con ripristino di emergenza (Disaster Recovery, DR) utilizza cluster a disponibilità
elevata (High Availability, HA) distribuiti su aree geografiche separate.

© 2023 Automation Anywhere. All rights reserved.     892

https://apeople.automationanywhere.com/s/article/Automation-360-Backing-up-and-restoring-a-Control-Room-High-Availability-Cluster
https://apeople.automationanywhere.com/s/article/Automation-360-Backing-up-and-restoring-a-Control-Room-High-Availability-Cluster
https://www.elastic.co/blog/a-new-era-for-cluster-coordination-in-elasticsearch


    Automation Anywhere - Installazione e aggiornamento Automation 360

Disaster recovery (DR) is a method where the two high availability (HA) data center configurations are
separated geographically. In the event of a localized disaster at the primary site, the physically removed
data center on the secondary site can resume functions with minimum downtime.
If there were external systems used in the setup, it is essential to restore the network level connectivity.
Some examples for these external systems include any external key vaults, Git, and so on. All the firewall
rules, IP white-listings, host-names referred in configurations are still intact and available to the restored
services.

Nota:  Si consiglia di fare in modo che i cluster Control Room nei siti di ripristino di emergenza primario e
secondario utilizzino un minimo di tre nodi ciascuno poiché una configurazione a tre nodi può contribuire
a evitare problemi di split-brain con cluster a due nodi e aumentare la sicurezza utilizzando le funzioni TLS
(Transport Layer Security) e di autenticazione dei nodi.

L'immagine seguente mostra i componenti Automation Anywhere del cluster del data center per tre
nodi nei siti primario e secondario configurati per il ripristino di emergenza. The Automation Anywhere
components are shown in orange and components provided by your organization are shown in blue. I
componenti ospitati centralmente su cloud e gestiti da Automation Anywhere come il server delle licenze
sono mostrati in bianco.
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Disaster recovery methods

There are two ways to perform disaster recovery - Image based replication and Warm standby. Choose the
option that meets your business continuity requirements.
Attività correlate
Image based replication alla pagina 895
The replication process is similar across environments and cloud providers. A scheduled way is used for
creating and storing the snapshots. The snapshot interval is based on the tolerance of the customer for
potential data loss.
Replicate data between primary and secondary sites alla pagina 899
The process of replicating the data between the primary and the secondary site involves database
replication using publisher and subscriber models in Microsoft SQL Server Management Studio, server
repository replication using Windows Distributed File System (DFS), and backing up Elasticsearch (audit
log) data.
Informazioni correlate
Cluster coordination in ElasticSearch

Image based replication
The replication process is similar across environments and cloud providers. A scheduled way is used for
creating and storing the snapshots. The snapshot interval is based on the tolerance of the customer for
potential data loss.
We recommend that the replication schedule should be at least 1 day (one snapshot daily).
The following describes the procedure for AWS as an example cloud provider.

As a first step in any image-based DR setup, create snapshots at fixed intervals. In case of the disaster, the
setup would revert to the latest good image/snapshot and system would be back, up and fully functional in
a short time, however with a data loss and short down time.
1. Decide on the snapshot interval based on potential data loss.
2. Stop the Automation Anywhere services on the server being imaged.
3. If on AWS, create AMI using standard image creation steps.

Create an AMI from an Amazon EC2 Instance

4. After the image is created, start the Automation Anywhere services.
5. Run the repository backup mechanism on the same schedule.
The subsequent steps describe restoring data from an image.
6. Spin a new instance using the previously created AMI.

Depending on the original setup, if the setup is spread across availability zones, you must do the same
in all relevant availability zones.

The following steps are applicable to each instance being recovered.
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7. Edit the configuration files related to the database server, Ignite cluster, and Elasticsearch to form the
clusters in the configuration directory.
On a standard installation, the files are located in: C:\Program Files\Automation Anywhere
\Enterprise\config

a) Edit the database server URL to point to the intended database server in:
boot.db.properties.
Do not change the URL if the original server already refers to a non-localhost address.

b) Edit the following property in the cluster.properties file:
Append the list with a new server IP in: ignite.discovery.static.ips=<existing list
 of ips>, <current server ip>

c) Edit the following properties in the elasticsearch.yaml file:
• Add the current server address in: node.name: "<local-ip>"
• Add the current server address in: network.host: "local-ip"
• Leave the existing values intact and append the IP of the current server in:

discovery.zen.ping.unicast.hosts: ["ip1","<local-ip>"]
• Leave the existing values intact in: cluster.initial_master_nodes: ["<master-

ip>"]

8. Opzionale: If mounted, restore the repository from the same timed snapshot as the selected Control
Room snapshot and mount to the respective path.

9. Update configuration tables.
10. Ensure Transmission Control Protocol (TCP) visibility between the nodes.
11. Start the services on the replicated node and wait for couple of minutes the clustering to establish.
12. Verify the following:

• Login and check the bots are listed and visible.
• If the installation has external Git configured, check the validity using functions such as check-in.
• Verify the audit logs.

13. Update the load balancer tier or DNS as needed if any host names/IPs change with corresponding
current values.

Attività correlate
Replicate data between primary and secondary sites alla pagina 899
The process of replicating the data between the primary and the secondary site involves database
replication using publisher and subscriber models in Microsoft SQL Server Management Studio, server
repository replication using Windows Distributed File System (DFS), and backing up Elasticsearch (audit
log) data.
Warm stand-by alla pagina 896
Host two setups or sites - primary and backup for the warm stand-by DR procedure.

Warm stand-by
Host two setups or sites - primary and backup for the warm stand-by DR procedure.
Each setup would have following recommended configurations:
1. Automation 360 hosted in clustered mode (three nodes)
2. SQL instance
3. Repository storage (shared network drive)
4. Git repository
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Synchronous replication of the data onto the backup node should be configured. The backup node should
have the exact same configuration as Primary node; except for Control Room.
• To sync Git repository, back up Git repository path from primary to backup path.
• To sync SQL database, setup replication from primary to backup database.

Replicate data between primary and secondary sites alla pagina 899

Once configured the setup scheme would look like this:
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Complete the disaster recovery deployment on the two geographically separated sites, where one site is
the primary (active) site and the other is the secondary (passive) site used for backup. If the primary site
cluster fails, perform recovery on the secondary site.

Nota:  The secondary site should be set up as a passive configuration so that the failover procedure can
be performed without delay.

The procedure is identical regardless of whether you are switching over from primary to secondary, or
from the secondary to primary sites. Connect the Control Room to the replicated database and shared the
repository on the secondary site.
These steps apply to all the servers in the Automation 360 cluster, including the Control Room servers, SQL
server, and Elasticsearch server.
1. Install Automation 360 on the secondary site.

Follow the steps for installation up to the database configuration.
Installing Control Room using Custom mode alla pagina 902

2. In the Database Configuration window, add database details for the secondary site such as the
database server IP address and default port number.
Configure Microsoft database type and server alla pagina 911

3. Verify the Elasticsearch details in the Provide Elasticsearch Credentials window.
Because the Elasticsearch data is already replicated from the primary database, you do not have to
provide the Elasticsearch password.

4. After the installation is complete, verify that the Control Room URL and repository path is available in
the Control Room Welcome page.
You can change the Control Room URL and repository path after you log in to the Control Room as the
next step.

5. Log in to the Control Room using your administrator credentials to change the Configuration
Settings in Administration > Settings:
a) To allow users to access the Control Room using a public IP address, change the Control Room

Access URL settings to point to the secondary site access URL in General Settings > General.
b) Change the Repository path to the secondary site repository path in Control Room database

and software > Control Room repository.

6. Verify the data for the following:
• Users, roles, schedule, triggers, credential information, and workload settings
• Elasticsearch certificate and connectivity
• Automation Anywhere Robotic Interface, Bot Insight, Discovery Bot, and IQ Bot

Nota:  Perform a byte-by-byte measurement of the recovered data and compare the primary and
secondary site data. If you see any difference, verify the subscriber logs for any intermittent failure
due to any network issue.

Dopo che il sito di ripristino funziona come sito primario, configura un sito secondario sostitutivo. Using the
database tools, set up replication from the recovery primary site to the replacement secondary site.

Replicate data between primary and secondary sites
The process of replicating the data between the primary and the secondary site involves database
replication using publisher and subscriber models in Microsoft SQL Server Management Studio, server
repository replication using Windows Distributed File System (DFS), and backing up Elasticsearch (audit
log) data.
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Before installing Automation 360, ensure that you have set up your secondary site.
Configure the database and shared repository in the secondary site that is used for disaster recovery. Back
up your Elasticsearch data by setting up the backup cluster.
1. Replicate the database from the primary site to the secondary site using the publisher and

subscriber models in Microsoft SQL Server Management Studio.

Recommendations:
• Use the Microsoft SQL Server Developer or Enterprise edition for database replication.

The publisher and subscriber versions must be the same, or the gap between the two versions
must not be more than two releases. For example, do not use Microsoft SQL Server 2012 publisher
with Microsoft SQL Server 2019 subscriber.

• Configure the publisher and distributor on the same system to avoid latency in data sharing.
Use different systems only for load distribution, for example, for data larger than 200 GB.

a) Connect to the primary database to create a snapshot publication for your local publications.
b) Add the tables and views as articles.
c) Use the snapshot agent option to create a snapshot and keep the snapshot available to initialize

subscriptions.
d) Schedule the snapshot agent to back up the data at regular intervals (for example, every 10

seconds from 12 AM to 11:59:59 PM).
e) To select the account to run the snapshot agent, configure the security and agent settings.
f) Add a publication option.
g) Run all agent and distributors after ensuring that the publisher and database names are correct.
h) To add subscribers to the local subscriptions, connect to the database server and provide

connection details for the database at the secondary site.

For detailed steps, see Database Mirroring and Replication (SQL Server).
2. Replicate the repository (bots and data files) using the Windows DFS from the primary site to the

secondary site.
a) Open the DFS on the machine where the shared repository is saved.
b) Create a new multipurpose replication group to add replication group members.

The group members include the source machine in the primary site and the destination machine
in the secondary site to store the shared repository.

c) Use the full mesh option for DFS replication groups composed of less than 10 servers.
d) Use the full bandwidth option to replicate the data continuously.
e) Add the machine where you are configuring the repository as a primary member.
f) Add a backup folder for the shared repository from the destination machine.
g) Verify that the data is replicated in the backup folder on the destination machine.

For detailed steps, see Distributed File System Replication.
3. Back up the Elasticsearch (audit log) data by adding the secondary site cluster IP address in the

Control Room on the primary site.
For detailed steps, see Configure disaster recovery site for Elasticsearch IP addresses alla pagina 972.
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Attività correlate
Warm stand-by alla pagina 896
Host two setups or sites - primary and backup for the warm stand-by DR procedure.

Installing Control Room using custom mode for Oracle installation
Install the Automation Anywhere Control Room using Oracle Database for On-Premises and complete the
installation in the Control Room.
Ensure the following:
• Oracle Database is preconfigured in your environment before you complete the Control Room

installation.
• Oracle 19c On-Premises or over AWS RDS Oracle is supported. Ensure that the following settings are

enabled with version 19c:
• The value of the Oracle instance max_string_size parameter is set to EXTENDED.
• If you want to use the SSL/TLS connection for the database, it is required that you configure TLS on

the Oracle Server.
• Oracle credentials are created. Database credentials must be created and the following grants must

be provided: CONNECT, RESOURCE, CREATE TABLE, CREATE VIEW.

Nota:  The QUOTA on tablespace USERS is UNLIMITED.

Nota:  External vault integration is not supported on Oracle-based Windows Control Room
installation.

Procedura

1. Prepare for installation
• Verify Automation 360 On-Premises prerequisites alla pagina 840.
• Assicurati di disporre di quanto segue:

• Automation Anywhere Control Room installation file
• TLS certificate
• License file

2. Run Control Room installer alla pagina 904.
Esegui il programma di installazione per verificare i requisiti del sistema operativo e dell'hardware,
seleziona l'opzione di distribuzione, accetta il contratto di licenza e seleziona il percorso del file di
installazione.

Nota:  Ensure that you select Oracle for Database type.

3. Configure application Transport Layer Security alla pagina 907.
Utilizza la pagina Configurazione di Transport Layer Security (TLS) per generare un certificato
autofirmato o importare un certificato di sicurezza per impostare un'istanza di Control Room altamente
sicura.
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4. Configura credenziali di servizio alla pagina 910.
Utilizza la pagina Credenziali di servizio per specificare l'account che verrà utilizzato per eseguire
tutti i servizi Windows creati dallo strumento di installazione.

5. Configure Oracle database type and server alla pagina 914
Use the Database type page to configure the Oracle Database for use with the Control Room.

6. Add Elasticsearch credentials alla pagina 916.
Aggiungi le credenziali Elasticsearch per migliorare il monitoraggio e gli avvisi nella Control Room.

7. Configura cluster IP alla pagina 917.
Utilizza la pagina Configurazione del cluster per configurare i requisiti di resilienza. Fornisci un solo
indirizzo IP per configurare la Control Room su un singolo nodo. Fornisci più indirizzi IP (tre o più) per
configurare la Control Room per il cluster a disponibilità elevata.

8. Review the installation summary.
Utilizza la pagina Pronto per l'installazione del programma per completare la procedura guidata
di installazione e monitorarne lo stato di avanzamento.

9. Complete Control Room configuration and validation.

Complete Control Room post-installation
configuration alla pagina 965

After installing the Control Room, complete
the configuration settings to ensure that timely
Automation Anywhere communications are
specified and confirm that Automation Anywhere
services are running.

Post-installation user management alla pagina
979

After completing the post-installation tasks,
validate the setup by logging in to the
Control Room and installing a license. Il
primo accesso alla Control Room ti guiderà
attraverso la configurazione in base al metodo di
autenticazione.

10. Prepare for users.
As an administrator, you can create, view, edit, delete, and enable or disable a user. The steps for
creating users can vary depending on whether the user is a non-Active Directory, Active Directory, or
single sign-on (SSO) user from an IdP server.

Installing Control Room using Custom mode
Accedi al server come amministratore e installa Automation Anywhere Control Room in modalità
Personalizzazione per selezionare le opzioni di installazione e configurazione, inclusa l'installazione di
requisiti non predefiniti. Select this mode for a data center deployment.

Linux users:  Consulta Installing Control Room on Linux alla pagina 948.
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Procedura

1. Prepare for installation
• Verify Automation 360 On-Premises prerequisites alla pagina 840.
• Assicurati di disporre di quanto segue:

• Automation Anywhere Control Room installation file
• TLS certificate
• License file

2. Run Control Room installer alla pagina 904
Esegui il programma di installazione per verificare i requisiti del sistema operativo e dell'hardware,
seleziona l'opzione di distribuzione, accetta il contratto di licenza e seleziona il percorso del file di
installazione.

3. Select the database type that you want to use
• Microsoft SQL Server
• Oracle

4. Utilizza la pagina Integrazione di un archivio chiave esterno per configurare una connessione
a un archivio chiave esterno, come CyberArk o AWS Secrets Manager, facoltativamente utilizzato per
recuperare le credenziali per scopi di installazione o di runtime. La configurazione della connessione
dell'archivio chiave abilita le opzioni di recupero delle credenziali durante l'installazione. Assicurati di
disporre delle seguenti informazioni:
• Tutte le credenziali utente e del database necessarie.
• Qualsiasi requisito di credenziale necessario per l'archivio chiave esterno, come chiavi segrete,

ID delle applicazioni. Consulta i requisiti specifici per il tuo archivio chiave esterno nella pagina di
configurazione dell'integrazione di un archivio chiave esterno.

5. Configure application Transport Layer Security alla pagina 907
Utilizza la pagina Configurazione di Transport Layer Security (TLS) per generare un certificato
autofirmato o importare un certificato di sicurezza per impostare un'istanza di Control Room altamente
sicura.

6. Configura credenziali di servizio alla pagina 910
Utilizza la pagina Credenziali di servizio per specificare l'account che verrà utilizzato per eseguire
tutti i servizi Windows creati dallo strumento di installazione.

7. Configurazione del tipo e del server del database
Use the Database type page to configure the Microsoft SQL Server database, or Oracle Database for
use with the Control Room.
• Configure Microsoft database type and server alla pagina 911
• Configure Oracle database type and server alla pagina 914

8. Add Elasticsearch credentials alla pagina 916
Aggiungi le credenziali Elasticsearch per migliorare il monitoraggio e gli avvisi nella Control Room.

9. Configura cluster IP alla pagina 917
Utilizza la pagina Configurazione del cluster per configurare i requisiti di resilienza. Fornisci un solo
indirizzo IP per configurare la Control Room su un singolo nodo. Fornisci più indirizzi IP (tre o più) per
configurare la Control Room per il cluster a disponibilità elevata.
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10. Esamina il riepilogo dell'installazione

Utilizza la pagina Pronto per l'installazione del programma per completare la procedura guidata
di installazione e monitorarne lo stato di avanzamento.

11. Complete Control Room configuration and validation

Complete Control Room post-installation
configuration alla pagina 965

After installing the Control Room, complete
the configuration settings to ensure timely
Automation Anywhere communications are
specified and confirm Automation Anywhere
services are running.

Post-installation user management alla pagina
979

After completing the post-installation tasks,
validate the setup by logging in to the
Control Room and installing a license. Il
primo accesso alla Control Room ti guiderà
attraverso la configurazione in base al metodo di
autenticazione.

12. Preparazione per gli utenti

As an administrator, you can create, view, edit, delete, and enable or disable a user. La creazione dei
passaggi per gli utenti varia a seconda che l'utente sia un utente non Active Directory, Active Directory
o Single Sign On da un server IdP.

Concetti correlati
Migrazione a Automation 360 alla pagina 1126

Run Control Room installer
Esegui il programma di installazione per verificare i requisiti del sistema operativo e dell'hardware,
seleziona l'opzione di distribuzione, accetta il contratto di licenza e seleziona il percorso del file di
installazione.
To install Automation Anywhere Control Room in Custom Mode, follow these steps:
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1. Start the installer wizard.
a) Extract all files from the Automation360_Build_<build-number>.zip file.
b) Right-click the Automation360.exe file and select Run as administrator.

The installation process will create a Control Room database with the name Automation360-Database
on your SQL database server instance.
However, if you are migrating from Enterprise 11 to Automation 360, the restored Enterprise 11
database will be used instead of the Automation 360 database.

Nota:  Assicurati che il server di database SQL sia installato su un server diverso da quello di Control
Room.

The installation process checks for supported operating system and recommended hardware
requirements. The following message appears if the requirements are not met:
Questo sistema non soddisfa tutti i prerequisiti di installazione per
 Automation Anywhere Enterprise. 
Some features might not work as expected after installation. Per i
 dettagli, verifica il prerequisito di installazione di Control Room. 

Per ulteriori informazioni, consulta Automation 360 On-Premises prerequisites alla pagina 840.
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2. Seleziona il tipo di distribuzione In sede e fai clic su Avanti.

Con tipo di distribuzione On-Premises, Control Room, Bots e file vengono installati sui tuoi server.
Con tipo di distribuzione Abilitata al cloud tutti i dati come bots e i file vengono installati sui tuoi
server. The management functions of the Control Room are delivered through Cloud.

3. Accetta il contratto di licenza e fai clic su Avanti.
4. Seleziona l'opzione Personalizzazione e fai clic su Avanti.

Viene visualizzata la pagina Cartella di destinazione. By default, the
destination folder is C:\Program Files\Automation Anywhere\.
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5. If you are upgrading from one Automation 360 version to another, confirm the upgrade and choose
whether to use the existing installation parameters.
Existing installation parameters include, for example: the installation path, HTTPS ports, database
names, IP addresses, and TLS configuration. The username and password have to be manually
entered.
• Sì: tutti i parametri di installazione sono precompilati e disabilitati. You cannot change pre-filled

fields.
• No: inserisci gli stessi o diversi parametri di installazione tramite i prompt di installazione.

Nota:  Scegli No se l'installazione precedente non ha utilizzato il percorso di installazione
predefinito C:\Program Files.

6. Per apportare modifiche alla cartella di destinazione, fai clic su Modifica, inserisci il nome della
cartella di destinazione e fai clic su OK.

Nota:  Non è consigliabile installare l'applicazione direttamente nella directory principale
(C:\). Devi creare una cartella, ad esempio C:\Program Files\Automation Anywhere
\Automation360\.

7. Fai clic su Avanti.

Integrate external key vaults
You can integrate external key vaults to the Automation 360 On-Premises Control Room.
As part of your external key vault integration planning strategy, if you determined that you are using an
Automation 360 On-Premises Control Room deployment (where the Control Room and external key vault
are hosted at the customer's site and environment), then select from the following list of external key
vaults to configure:
• CyberArk Password Vault – Customer On-Premises environment

On-Premises integration using CyberArk Password Vault alla pagina 2865
• Azure Key Vault – Customer Azure environment

On-Premises integration using Azure Key Vault alla pagina 2880
• AWS Secrets Manager – Customer AWS environment

On-Premises integration using AWS Secrets Manager

Configure application Transport Layer Security
Use the Transport Layer Security (TLS) configuration wizard page from the Automation 360 installer
to generate a self-signed certificate or import a security certificate to set up a highly secure Control Room
instance.

Automation Anywhere leverages TLS 1.2 and TLS 1.3 encryptions for HTTPS and TCP communications
between our components. The TLS certificates are installed on the Automation Anywhere Control Room
and IQ Bot servers. The certificates are installed in .PFX format and leveraged for communications.
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Nota:  If your load balancer uses HTTP to forward traffic to the Control Room, do not use the Enable
Force HTTP traffic to HTTPS option. We recommend that you use HTTPS to forward the load balancer
traffic for enhanced security instead.

1. In the TLS Configuration page, configure the following:
• Generate a Self-Signed Certificate

Enabling the Self-Signed Certificate option allows the installer to generate a unique private key
and a self-signed certificate for the Control Room.

• Import a Certificate
To import a custom certificate, clear the Self Signed Certificate check box. This setting allows
you to import a certificate using the Certificate Path field.

Nota:  The certificate file must be a PKCS12 format.

Provide the following information:
• Certificate Path: Click Browse to import the certificate.
• Private Key Password: Enter the password for the private key.

Password limitation:  Do not use the at sign (@) in passwords. Using the special character @
in the password causes the certificate file import to fail.

• Webserver Port: Enter the web server port – either HTTP or HTTPS. If the port is already
assigned, an error message is displayed.

Importante:  The port validation message is also displayed when you add 8080 for the web
server and if that port is already in use for a Control Room license service. Use a different
unassigned port in these cases.

• Enable Force HTTP traffic to HTTPS: This option redirects all HTTP port requests to HTTPS.
To access to the Control Room through HTTPS using the generated self-signed certificate,
ensure the port numbers are different for HTTP and HTTPS.
To generate a custom certificate for HTTPS, ensure your custom certificate meets the following:
• Create a .pfx certificate with a pass code from a CA trusted authority.
• Combine Root, Intermediate, and Machine level certificates into a single certificate.
• Use the format [WS Machine Host Name].[DomainName].com for the private key.
• Include the host name as a fully qualified domain name (FQDN) in the certificate.

You provide the host name during Control Room installation.
• In multi-node HA clusters, issue certificates to the load balancer DNS name.
• Add individual URLs, which require access to all nodes, to the Subject Alternative

Name field in the certificate.

For more information, see Automation Anywhere support site: Automation 360 On-Premises
prerequisites (A-People login required).
The following sample illustration shows options for importing a custom certificate:
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2. Click Next to configure service credentials.
Configura credenziali di servizio alla pagina 910

Attività correlate
Configure Control Room for HTTPS certificate alla pagina 969
Configure Control Room for HTTPS mode using a self-signed or CA certificate either before or after
performing a custom Control Room configuration.
Import HTTPS,and CA certificates alla pagina 970
After you install the Control Room for an On-Premises deployments, you can use the Windows or Linux
command prompt to import all or some of these certificate:
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Configura credenziali di servizio
Continue from the Control Room installer to the Service Credentials wizard page. Use this page to
specify the account that will be used to run all Windows services that are created by the Automation
Anywhere installer.
1. In the Service Credentials screen, choose from the listed options.

The Windows Service credentials include a user name and password. The user specified must meet
these requirements:
• Have permission to manage services, including Automation Anywhere services.
• If you use Windows authentication to connect to the SQL database, ensure you grant the

db_owner permission to the service credential user.

These service credentials allow the Control Room processes to run the required services.
• Local System Account—(default) The logged-on user performing the installation.

• Use a Group Managed Service Account—Specify to manage Automation 360 services.
a. Clear the Local System Account check box.
b. Select the Use a Group Managed Service Account option.
c. Enter the user name only. No password is required to use this option.

Group Managed Service Accounts Overview
• Domain Account—Specify a user that is not the local system account user

a. Clear the Local System Account check box.
b. Enter the user name and password for the domain account.

Utilizza solo caratteri supportati per il nome utente e la password. Consulta Supported special
characters alla pagina 874.

• • Do not use the Windows domain credentials
Enter credentials valid for running Automation Anywhere services. Without the valid
credentials, the Control Room will fail to launch.

• PowerShell script restrictions
Specify a user with permissions to launch PowerShell scripts who is not a Windows domain
user. Without the relevant permissions, database table creation can fail.

• Service Account (manually enter credential)
a. Immetti il nome utente.
b. Immetti la password.

• Service Account (optionally retrieve service account credential from the previously
configured external key vault )
a. If using CyberArk, enter the safe name and object name for the credential.
b. Se si utilizza AWS Secrets Manager, immetti il nome segreto.
c. If using Azure, enter the vault URL.

The following example shows selection of a domain account:
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2. Fai clic su Avanti.

Configure Microsoft database type and server
Passa dal programma di installazione di Control Room alla pagina della procedura guidata Tipo di
database. Use this page to configure the Microsoft SQL Server database for use with the Control Room.
Questa procedura si applica solo alle installazioni basate su Microsoft Windows Server.

Linux users:  Vedi Installazione di Enterprise Control Room su Linux - Configurazione del database.

Se stai installando Automation 360 come parte della migrazione, questa attività include la procedura per
selezionare il database Enterprise 11 (clonato).
1. Seleziona il database Microsoft SQL Server.

Un'istanza di SQL Server deve essere già configurata.
2. Fai clic su Avanti.

Viene visualizzata la pagina Server di database (se è stato selezionato SQL Server per la
configurazione del database).
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3. Imposta la connessione e l'autenticazione per il server di database.
To configure the Database Server for the Control Room instance, use the default Database Server
port 1433. If multiple instances are running on the same database host on different ports, you can use
the corresponding custom port for that instance (for example, 1435 or 1437).

Nota:  The instance name is not supported in the Database Server field.

Nota:
• Se possibile, non impostare il valore per Server di database come localhost. Se è necessario

utilizzare localhost, tieni presente che la Connessione protetta al database non funzionerà.
•
• Fai clic sul pulsante Sfoglia per selezionare l'istanza di SQL Server in cui verrà creato il database

di Control Room. In alternativa, inserisci il nome di un server di database o selezionane uno
dall'elenco.

Attività della migrazione: Se stai eseguendo la migrazione da Enterprise 11 a Automation 360, vai
al database Enterprise 11 ripristinato.
Fornisci i seguenti dettagli:
a) Porta di database: Utilizza la porta predefinita (1433) o specifica un valore personalizzato.

Configure default database port alla pagina 914
b) Usa connessione sicura: Seleziona per utilizzare un certificato CA come specificato.

Nota:  Utilizza lo stesso nome host per il certificato e le connessioni al database.

c) Certificato: Questa opzione è abilitata quando si seleziona Usa connessione sicura. Sfoglia
per selezionare un certificato CA.
Import HTTPS,and CA certificates alla pagina 970

d) Seleziona una delle seguenti opzioni per l'autenticazione del database:
• Autenticazione Windows: Questa opzione è selezionata per impostazione predefinita e

consente la connessione a SQL Server tramite l'autenticazione Windows.

Nota:  Se selezioni l'autenticazione Windows, l'utente che esegue lo strumento di installazione
viene utilizzato per verificare che il database esista, crearlo se necessario e assegnare
db_owner all'utente dell'account di servizio (NT Authority/System).

• Autenticazione SQL Server: (immetti manualmente le credenziali) Seleziona questa opzione
per utilizzare l'autenticazione SQL Server per connetterti al database. Indica il nome utente e
la password corretti per l’autenticazione SQL.
1. Immetti il nome utente.
2. Immetti la password.

• Autenticazione SQL Server: (recupera le credenziali dall'archivio chiave esterno). Seleziona
questa opzione per utilizzare l'autenticazione SQL Server per connetterti al database.

Nota:  L'autenticazione SQL Server è necessaria se si recuperano le credenziali per il database
da un archivio chiave esterno.

1. Se si utilizza CyberArk, immetti il nome sicuro e il nome dell'oggetto.
2. Se si utilizza AWS Secrets Manager, immetti il nome segreto.
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• Autenticazione AD Azure: Seleziona questa opzione per utilizzare le credenziali Microsoft
Azure Active Directory per connettersi al database quando si installa Control Room su Microsoft
Azure.

Utilizza solo caratteri supportati per il nome utente e la password. Consulta Supported special
characters alla pagina 874. Non utilizzare punti e virgola ( ; ) nella password del database.

e) Nome del database della sala di controllo: Inserisci il nome del database di Control Room.
Attività della migrazione: Se stai eseguendo la migrazione da Enterprise 11 a Automation 360,
inserisci il nome del database ripristinato nel campo del database come mostrato nell'immagine
seguente:

The following sample illustration shows SQL Server authentication for database

connection:
4. Fai clic su Avanti per fornire le credenziali di Elasticsearch.

Add Elasticsearch credentials alla pagina 916
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Configure default database port
Configure and enable the TCP/IP in the SQL database server to use the default port 1433 when you install
the Control Room.
Enable TCP/IP from the Microsoft SQL Server Configuration Manager.
1. Ensure the SQL Server Browser service is running in the Task Manager.
2. To set the default port for the SQL database server, launch the Microsoft SQL Server Configuration

Manager.
3. Select SQL Server Network Configuration > Protocols for <SQL server instance>.
4. Right-click Protocols for <SQL server instance> and select Open to show the available protocols.
5. Ensure TCP/IP is enabled.
6. Right-click TCP/IP and select Properties.

You can configure the default port for the SQL database from the TCP/IP Properties window that is
displayed.

7. Select the IP Addresses tab to update the default TCP Port to 1433 in the IPAll node.
If provided, clear the value shown in the TCP Dynamic Ports field.

8. Click OK to confirm and exit the window.
9. Select the SQL Server Services option to Restart the SQL Server <instance name>.

The SQL database server is now configured and enabled to use the default port in the Control Room.

Configure Oracle database type and server
Configure the Oracle Database Server for use with the Control Room by using the Database type wizard
page.
This procedure applies only to installations based on Microsoft Windows Server.
Oracle must be installed on a machine that is accessible from the Automation 360 Control Room.
Create users for Automation Anywhere to access the Database.
This is supported only on non-container Database. Oracle installation is supported only for first-time setup
of Automation Anywhere. Oracle installation does not support updates.

Nota:  Oracle database for Control Room installation is supported only in Custom mode and not in Express
mode.

1. Select Oracle database.
An instance of the Oracle Server must be configured already. Per ulteriori informazioni, consulta
Installing Control Room using custom mode for Oracle installation alla pagina 901.
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2. Fai clic su Avanti.
The Oracle Database server page is displayed (if you selected Oracle for configuring your database).
The following sample illustration shows Oracle Database Server authentication for database
connection:

3. Imposta la connessione e l'autenticazione per il server di database. Fornisci i seguenti dettagli:
a) Database Server: Enter the server name or IP address of the Oracle Database server.

The localhost IP address can be used.
b) Porta di database: Enter your database server port number. The default port is 1521.
c) For the connection, select one of the following options and enter the name of your Oracle

instance in the text field:

Opzione Action in text field (example)

SID ORCL

Nome servizio ORCLPDB

Nota:  The SID and service name entered in the text field provided is unique to your Oracle database.
The Oracle instance name entered in the text field is not case-sensitive.

4. In the Username field, enter your Oracle database user or schema name.
5. In the Password field, enter the password for the user or schema name.
6. Usa connessione sicura: Seleziona per utilizzare un certificato CA come specificato.

Nota:  Utilizza lo stesso nome host per il certificato e le connessioni al database.

7. Certificato: This option is enabled when you select Use Secure Connection. Browse to select a CA
certificate.
Import HTTPS,and CA certificates alla pagina 970
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8. Fai clic su Avanti.
The database connection begins validating for the database server and the elastic search.

9. Enter the Elasticsearch credentials in the fields provided.
Add Elasticsearch credentials alla pagina 916

Add Elasticsearch credentials
When installing Automation 360, add Elasticsearch credentials for enhanced security.
Based on whether you are performing a new installation, running the setup for the first time to upgrade to
a later version, or a subsequent re-installation, the options to add the Elasticsearch credentials or select a
backup Elasticsearch server are enabled.
1. In the Provide Elasticsearch Credentials window, enter the credentials for Elasticsearch in the

Elasticsearch password field.

Importante:  Ensure the following for your Elasticsearch authentication password:
• The password cannot include a space, semicolon (;), percent (%), or backslash (\).
• The first character cannot be a minus sign (-) or forward slash (\).
• Include at least one alphabetical character.

This option is enabled only for the primary node of the cluster when you run the setup for the
first time for an upgrade or a new installation of the Control Room. When you enter the password,
self-signed certificates are generated for encrypting the data traffic for inter-node and client
communication.
The option is disabled for subsequent installations because the password and certificates are retrieved
and reused from the second node onwards.

2. Repeat the credentials in the Confirm Elasticsearch password field.
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3. Select the Check only if installing on the first node of the backup Elasticsearch cluster check
box when you want to install the Control Room on the primary node that will be used as a backup for
the Elasticsearch cluster.
This option is available only if you have provided the Elasticsearch credentials for the primary node
during a previous installation. The option enables you to use the database backup that is created from
the Elasticsearch settings table after the primary node of the cluster is installed.
The option is disabled for subsequent installations.

4. Click Next to configure the IP cluster.

If you encounter errors when performing this task, see these resources:
• Error on storing Elasticsearch certificate to database, see Installation error storing Elasticsearch certificate

to database (A-People login required).
• Error restarting the Automation Anywhere Elastic Search Service, see Automation 360 v.16 upgrade error:

Elasticsearch Service fail to start during certificate retrieval process (A-People login required).

Configura cluster IP alla pagina 917.

Configura cluster IP
Use the Cluster Configuration wizard page under Custom installation type in Control Room installer
to configure resiliency requirements. Select the Enable Cluster setup option and for high availability
cluster, provide multiple (three or more) IP addresses from your cluster setup.
Before you install Control Room in cluster mode:
• Ensure that the default/custom and configurable firewall, port, and protocol requirements for

Automation 360 deployment are configured. Per ulteriori informazioni, consulta Requisiti di porte,
protocolli e firewall alla pagina 859.

• Ensure that the network location (UNC) path is configured to access the repository files from all Control
Room nodes in the cluster.
Ensure that the Network Attached Storage (NAS) file sharing can be configured using Server Message
Block (SMB) protocol.

• Ensure that all nodes that will be configured for the IP cluster are available for configuration before
the installation. Also, while installing on each of the node, ensure that the list of IP addresses of all
nodes are provided in the same order when configuring the Cluster IP addresses field in Cluster
Configuration wizard page.
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• Ensure to sign all the PowerShell files if the machine on which you are installing Automation 360 has
MachinePolicy as AllSigned or UnRestricted. For example on how signing in a Windows PowerShell
script, see Signing in Windows PowerShell scripts.

To view the MachinePolicy on your machine, run the following command in PowerShell:

Get-ExecutionPolicy -List

You can find the following PowerShell files in the temp folder:
• servicecredsvalidate
• getsysip
• getfileprodversion
• ecertprocess
• createstoragetables
• createpddtables
• createiqbottables
• createcrdbtables
• createaaridbtables

Example of a temp folder path: C:\Users\ADMINI~1.FD\AppData\Local\Temp\<GUID>.

Nota:  GUID is generated dynamically for each installer session.

A sample URL for reviewing the health of the cluster is:

https://<cr ip>:47599/_cat/health?pretty

You are prompted to enter the following credentials:
• Username: es_client (default)
• Password: <your set_ elastic_search_password>

A green or yellow color icon is displayed for a healthy cluster.

1. Select the Enable Cluster Setup check box.
2. If the nodes in your network use IPv6 address, select the IPv6 check box.
3. Enter the IP addresses of the nodes in the cluster.

Use a comma (,) to specify more than one IP address. For example, to specify three IP addresses in
the cluster, enter: 192.0.2.1,192.0.2.2,192.0.2.3

Nota:  The first IP address in the list is used as the initial master node. Ensure that you enter the IP
addresses in the same order on all node configurations in subsequent installations.

You can install multiple nodes at the same time after the master node is installed. After installation,
you can add a new IP address to the cluster at the end of the list. However, you cannot change the IP
address version (such as IPv4 to IPv6).
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4. Select an IP address from the Local IP Address drop-down list.
If multiple local IP addresses are configured on the machine, ensure that you select
an IP address (private IP address recommended) on which the Control Room is
installed, as it will be used by other nodes internally to communicate with each other.

5. Click Next to complete the Control Room installation process.
6. Opzionale: To review or monitor the installation progress, see Setup installation summary alla pagina

922.

Concetti correlati
High availability deployment alla pagina 891
To support Automation 360 in your data center, configure an high availability (HA) cluster. Follow your
company methods and procedures for implementing your data center cluster.
Attività correlate
Configure application Transport Layer Security alla pagina 907
Use the Transport Layer Security (TLS) configuration wizard page from the Automation 360 installer
to generate a self-signed certificate or import a security certificate to set up a highly secure Control Room
instance.
Riferimenti correlati
Requisiti dell'archivio Control Room alla pagina 865
La posizione dell'archivio viene configurata in Control Room dopo l'installazione. Tutte le automazioni
vengono memorizzate in questo archivio.
Requisiti di porte, protocolli e firewall alla pagina 859
Visualizza i requisiti predefiniti e configurabili di firewall, porta e protocollo per la distribuzione di
Automation Anywhere. View the default ports and protocols that are required to be allowed on customer's
firewall for Automation Anywhere deployment. The default ports that are used for HTTP/HTTPS are
configurable.

Add nodes to a cluster setup
As an RPA platform administrator, you can add nodes to a cluster for better performance and better load
distribution.
Ensure the following:
• Verify whether the prerequisites for on-premises installation are met.
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Automation 360 On-Premises prerequisites alla pagina 840
• Verify that all the primary nodes and databases have backups.
• You must have the IP addresses of all the cluster members for the Control Room server network

interfaces used for Elasticsearch communications.

Nota:  The Control Room servers can have multiple network interfaces. The server IP addresses must
be statically assigned and cannot use the Dynamic Host Configuration Protocol (DHCP).

• If any external load balancers are used in the environment, update them with IP addresses from the
new server nodes.

• Ensure that you have administrator or root privileges on the Control Room servers. You must be familiar
with installing Control Room in custom mode and also with the related configuration settings.

Adding nodes to a cluster helps you to upgrade the configuration of the nodes in a cluster. You can add
nodes to a Control Room cluster setup, change the IP addresses of nodes in the cluster, and monitor the
health of the underlying cluster services.

Nota:  The minimal number of nodes supported within a Control Room cluster is three. The nodes in a
cluster synchronize with each other over a local network. All the nodes in a cluster connect to the same
database.

Perform the following steps to add three nodes (N4, N5, and N6) to a cluster that has three nodes (N1, N2,
and N3).
1. On node N4, log in to the operating system as an administrator and run the Control Room installer.
2. Proceed through the installer to the cluster configuration.

a) Select Enable Cluster Setup.
b) In the Cluster IP addresses box, enter the IP addresses of all the nodes that you need to

configure in the cluster.
172.31.30.120, 172.31.21.216, 172.31.17.110, 172.31.20.242,
 172.31.17.149, 172.31.18.37

c) Select or add your Local IP address.

Nota:  The IP addresses must be entered in the same sequence on every node.

3. Restart the nodes, one at a time.
After you restart the nodes, each node will have six IP addresses.

4. Complete the remaining steps to install Control Room.
Installing Control Room On-Premises alla pagina 838

5. Repeat the steps 1 alla pagina 920 through 4 alla pagina 920 for nodes N5 and N6.
6. Ensure that all the Control Room services have started for all the nodes.
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7. To verify the health of the cluster, use the Elasticsearch API through a browser or API tool.
a) From a browser, navigate to the IP address of any node in the cluster by using the Elasticsearch

port 47599 and use the _cat/nodes API.
https://172.31.30.120:47599/_cat/nodes

The master node is indicated by an asterisk character (*).
b) Verify that the IP address of the master node is the same as the one mentioned in the

elasticsearch.yml file for all the nodes.
c) From a browser, navigate to the IP address of any node in the cluster by using the Elasticsearch

port 47599 and use the _cat/health?pretty API.
https://172.31.30.120:47599/_cat/health?pretty

You must wait until the replication status turns green. The replication time varies depending on the
data load in the clusters. The replication status turns green when the cluster is fully synchronized.

Remove nodes from a cluster setup
As an RPA platform administrator, you can remove nodes from a Control Room cluster setup to replace
them or upgrade them for enhanced performance.
Ensure the following:
• Verify that all the primary nodes and databases have backups.
• Ensure that you have administrator or root privileges on the Control Room servers.

Perform the following steps to remove three nodes (N1, N2, and N3) from a cluster that has six nodes (N1,
N2, N3, N4, N5, and N6).
1. Verify the master node. Use the following Elasticsearch API through a browser or API tool to identify

the master node:
https://172.31.18.37/_cat/nodes

2. Log in to the server as an administrator and stop all the Control Room services by running the
following command:
services.msc

Log in to any of the original nodes N2 or N3 and not the master node N1.
3. Similarly, stop all the Control Room services for the master node N1.
4. Before removing the nodes, verify the health of the cluster by using the following Elasticsearch API

through a browser or API tool:
From a browser, navigate to the IP address of any node in the cluster by using the Elasticsearch port
47599 and use the _cat/nodes API.
https://172.31.18.37/_cat/nodes

Nota:  The master node is indicated by an asterisk character (*).

5. Edit the cluster.properties file located at C:\Program Files\Automation Anywhere
\Automation 360\config.

6. Remove the IP addresses for the original three nodes from the cluster.properties attribute.

Nota:  Perform this action for all the nodes in the cluster. When you remove the IP addresses of the
original three nodes, do not change their sequence.

7. Edit the elasticsearch.yml file at C:\Program Files\Automation Anywhere\Automation
 360\elasticsearch\config.
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8. Remove the IP addresses for the original three nodes from the discovery.zen.ping.unicast.hosts
attribute.

Nota:  The discovery.zen.ping.unicast.hosts attribute must contain the IP addresses only for the new
nodes and in the same sequence within the file on each node.

9. To verify the new master node, use the following Elasticsearch API through a browser or API tool:
https://172.31.18.37/_cat/nodes

10. Update the IP address of the new master node in the cluster.initial_master_nodes attribute.
11. Run the following command to start the services on each node:

services.msc

You must start the services on the master node at the end.
12. To verify the health of the cluster, use the Elasticsearch API through a browser or API tool.

a) From a browser, navigate to the IP address of any node in the cluster by using the Elasticsearch
port 47599 and use the _cat/nodes API.
https://172.31.30.120:47599/_cat/nodes

Nota:  The master node is indicated by the asterisk character (*).

b) From a browser, navigate to the IP address of any node in the cluster by using the Elasticsearch
port 47599 and use the _cat/health?pretty API.
https://172.31.30.120:47599/_cat/health?pretty

You must wait until the replication status turns green. The replication time varies depending on
the amount of data in the clusters. The replication status turns green when the cluster is fully
synchronized.

Setup installation summary
Continue from the Control Room installer to the Ready to Install the Program wizard page. From this
stage of the installation wizard, you finish the installation wizard and monitor the installation progress.
1. Fai clic su Avanti.

The Ready to Install the Program screen appears.
2. Click Install and allow the installation process to complete.

The InstallShield Wizard Completed screen appears.
3. Click Finish.

Launch Automation Anywhere is enabled by default.
Abilita Mostra impostazioni programma di installazione per aprire il file aae-
installsummary.html. By default, this is located at C:\Program Files\Automation
 Anywhere\Enterprise\. Use this file to view a summary of the installation.

Complete the Control Room configuration and validation.
• Complete Control Room post-installation configuration alla pagina 965

After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.

• Post-installation user management alla pagina 979
After completing the post-installation tasks, validate the setup by logging in to the Control Room and
installing a license. First time access to the Control Room walks you through the configuration for your
authentication method.
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• Utenti alla pagina 2683
In qualità di utente Cloud con autorizzazioni di amministratore, puoi creare, visualizzare, modificare,
eliminare, abilitare o disabilitare un utente. La creazione dei passaggi per gli utenti varia a seconda che
l'utente sia un utente non Active Directory, Active Directory o Single Sign On da un server IdP.

Attività correlate
Installing Control Room using Express mode alla pagina 923

Installing Control Room using Express mode
Accedi ai server come amministratore e installa Automation Anywhere Control Room in modalità Express
utilizzando le impostazioni predefinite.

Nota:  Linux users, see Installing Control Room on Linux alla pagina 948.

• Verify Automation 360 On-Premises prerequisites alla pagina 840.
• Assicurati di disporre di quanto segue:

• Automation Anywhere Control Room installation file
• TLS certificate
• License file

Importante:  This installation mode is ideal for demo and training purposes. Questa modalità di
installazione è non è consigliata per l'ambiente di produzione.

The Express Mode installation quickly sets up the Control Room with default parameters for the various
components.
Parametri predefiniti
Microsoft SQL Server is the default database for Control Room.
The following parameters are installed by default:

Parametro Valore predefinito

SQL database instance SQLEXPRESS

Tipo di autenticazione Autenticazione Windows

database di Control Room Automation360-Database

Porta 1433

To install Automation Anywhere Control Room in Express Mode, follow these steps:
1. Log in to the installation server.
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2. Start the installer wizard.
a) Extract all files from the Automation360_Build_<build-number>.zip file.
b) Right-click the Automation360.exe file and select Run as administrator.

Il processo di installazione crea il database Control Room con il nome Automation360-Database
sull'istanza del server di database SQL.

Nota:  Assicurati che il server di database SQL sia installato su un server diverso da quello di Control
Room.

The installation process checks for supported operating system and recommended hardware
requirements. The following message appears if the requirements are not met:
Questo sistema non soddisfa tutti i prerequisiti di installazione per
 Automation Anywhere Enterprise. 
Some features might not work as expected after installation. Per i
 dettagli, verifica il prerequisito di installazione di Control Room. 

Per ulteriori informazioni, consulta Automation 360 On-Premises prerequisites alla pagina 840.
3. Fai clic su Avanti nella pagina di benvenuto della procedura guidata di installazione.
4. Seleziona uno dei seguenti tipi di distribuzione e fai clic su Avanti:

Tipo di distribuzione Descrizione

On-Premises The Control Room, Bots and files are installed on
your servers.

Abilitato al cloud All data such as bots and files are installed on
your servers. The management functions of the
Control Room are delivered through Cloud.

5. Accetta il contratto di licenza e fai clic su Avanti.
6. Nella pagina Tipo di installazione, seleziona l'opzione Express e fai clic su Avanti.

The Database Server configuration page appears.
a) inserisci la porta che desideri utilizzare per stabilire la connessione al server di database nel

campo Porta.
The default port is 1433. The installer uses the first available port and checks the availability of
each consecutive port.

b) Select any one of the following options to connect to the database server.

Opzione Azione

Usa autenticazione Windows The system uses your Windows
credentials. The Login ID and
Password fields are disabled in the
installer.

Autenticazione SQL Server Enter the Login ID and Password
used for connecting to the database
server.
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Opzione Azione

AD Azure authentication Enter the Login ID and Password
used for connecting to the database
server.
Select this option to use Microsoft Azure
Active Directory credentials to connect
to the database when you install the
Control Room on Microsoft Azure.

Nota:  The user who connects to the database server must have database creator privileges.

c) Inserisci il nome del database che desideri utilizzare per Control Room nel campo del database
Nome della sala di controllo.

7. Click Next on Provide Elasticsearch credentials page to configure Elasticsearch for enhanced
monitoring and alerting in the Control Room.

Importante:  Ensure the following for your Elasticsearch authentication password:
• The password cannot include a space, semicolon (;), percent (%), or backslash (\).
• The first character cannot be a minus sign (-) or forward slash (\).
• Include at least one alphabetical character.

This option is enabled only for the primary node of the cluster when you run the setup for the
first time for a new installation or an upgrade of the Control Room. When you enter the password,
self-signed certificates are generated for encrypting the data traffic for inter-node and client
communication.
The option is disabled for subsequent installations because the password and certificates are retrieved
and reused from the second node onwards.

8. Opzionale: When you want to install the Control Room on the primary node that will be used as a
backup for the Elasticsearch cluster, select the Check only if installing on the first node of the
backup Elasticsearch cluster check box.
This option is available only if you have provided the Elasticsearch credentials for the primary node
during a previous installation. The option enables you to use the database backup that is created from
the Elasticsearch settings table after the primary node of the cluster is installed.
The option is disabled for subsequent installations.

9. Fai clic su Avanti.
10. Su Pronto per installare il programma, fai clic su Installa e consenti il completamento del

processo di installazione.
During this process, the Automation 360 services are started automatically.

11. Nella pagina Installazione guidata InstallShield completata, fai clic su Fine.
Launch Automation 360 is enabled by default.
Abilita Mostra impostazioni programma di installazione per aprire il file aae-
installsummary.html. By default, this is located at C:\Program Files\Automation
 Anywhere. Use this file to view a summary of the installation.

The Control Room launches in your default browser with the Configure Control Room settings page
displayed. Proceed to Complete Control Room post-installation configuration alla pagina 965.
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Concetti correlati
Installing Control Room using Custom mode alla pagina 902
Accedi al server come amministratore e installa Automation Anywhere Control Room in modalità
Personalizzazione per selezionare le opzioni di installazione e configurazione, inclusa l'installazione di
requisiti non predefiniti. Select this mode for a data center deployment.

Installing Control Room on Amazon Web Services
Log in to an Amazon Web Services (AWS) server instance as Administrator. Then, download and start the
Control Room installer and select Custom mode.

Nota:
• Many possible system configurations and requirements exist. These installation steps do not account for

all those possibilities, so your specific setup and installation steps will vary, and Automation Anywhere
does not make any warranties that these steps conform to your specific configurations.

• For Automation 360 to work properly on Amazon Workspace, update the registry on all Workspace
machines. For details, see Compatibilità del dispositivo alla pagina 1032.

Passaggio 1: Prepare for installation • Verify Automation 360 On-Premises prerequisites
alla pagina 840.

• Assicurati di disporre di quanto segue:
• Automation Anywhere Control Room

installation file
• TLS certificate
• License file

Passaggio 2: Prepare for installation on Amazon Web
Services alla pagina 927

Use these steps to prepare the Amazon Web
Services (AWS) instances for the Control Room
installation.

Passaggio 3: Customize Control Room installation on
Amazon Web Services alla pagina 928

Install and apply the customized configuration
required for the Control Room cluster on Amazon
Web Services (AWS) after completing initial
preparations.

Passaggio 4: Complete Control Room
configuration and validation. Complete Control

Room post-installation
configuration alla
pagina 965

After installing the
Control Room, complete
the configuration
settings to ensure timely
Automation Anywhere
communications are
specified and confirm
Automation Anywhere
services are running.

Post-installation user
management alla pagina
979

After completing the
post-installation tasks,
validate the setup by
logging in to the Control
Room and installing a
license. First time access
to the Control Room
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walks you through the
configuration for your
authentication method.

Passaggio 5: Prepare for users. Utenti alla pagina
2683

In qualità di utente
Cloud con autorizzazioni
di amministratore, puoi
creare, visualizzare,
modificare, eliminare,
abilitare o disabilitare un
utente. La creazione dei
passaggi per gli utenti
varia a seconda che
l'utente sia un utente
non Active Directory,
Active Directory o Single
Sign On da un server
IdP.

Prepare for installation on Amazon Web Services
Effettua questi passaggi per preparare le istanze di Amazon Web Services (AWS) per l'installazione di
Control Room.
If you have not done so already, prepare your AWS Identity and Access Management (IAM) user account
to login to the AWS Console.
Do the following:
1. Create AWS Elastic Compute Cloud (EC2) Instances for the Control Room Servers.
2. If you use RDS, create Relational Database Service (RDS) Instances for the SQL Server Enterprise

2014 Database server.
3. Configure the AWS Load Balancer.

Nota:  There are many possible system configurations and requirements. These installation steps do not
account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.

To prepare AWS instances, do the following:
1. Set up the Microsoft SQL Server on Amazon Web Services Elastic Compute Cloud (AWS EC2) or

Relational Database Service (RDS).
AAE supporta entrambi. Per un confronto tra i due, vedi Microsoft SQL Server su AWS.
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2. Test the database connection with the Microsoft SQL Server.
a) Install Microsoft SQL Management Studio on one of the AWS EC2 instances inside the Virtual

Private Cloud (VPC).
Per ulteriori informazioni, vedi Download di SQL Server Management Studio.

b) Connect to the Microsoft SQL Server.
For configuration information, see Working with SQL Servers alla pagina 848.

c) (Skip this step if the master database user installs the Control Room). Create the following empty
database and assign db_owner privileges to the master database user for the Automation360-
Database.

3. Set up the shared repository.
a) Crea un'istanza AWS EC2 come un file server Windows con un volume aggiuntivo di 100 GB.
b) Join the Active Directory domain.
c) Create a folder and set up the permissions for the repository.

Assign the Control Room admin full access to this folder.

Importante:  Only the Control Room admin is to have full access to this folder because this is
the account from which all Control Room services run.

4. Launch three AWS instances, one for each Control Room server.
a) Establish three AWS instances, each with the following configuration:

• Tipo: c5.2xlarge o tipo di istanza simile (8 CPU, 16 GB di RAM)
• Storage: Root Device: 100 GB
• Storage: Additional Device: D:\ 200 GB (per i file di installazione di Automation Anywhere)
• Accidental Deletion Prevention: Abilitato

b) Access the three instances through Remote Desktop Protocol.
c) Add the instances to the Active Directory domain.
d) For each instance, add the Control Room system admin as a local administrator on the computer

and reboot the system.

5. Configure the firewall and port.
Consulta Requisiti di porte, protocolli e firewall alla pagina 859.

6. Set up the AWS Application Load Balancer.
VediDettagli per i prodotti Elastic Load Balancing.
• Disable the stickiness attribute.
• Set the idle time-out to 120 seconds.

7. Upload the SSL certificate to the Load Balancer.

Continue with Customize Control Room installation on Amazon Web Services alla pagina 928.

Customize Control Room installation on Amazon Web Services
Install and apply the customized configuration required for the Control Room cluster on Amazon Web
Services (AWS) after completing initial preparations.
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If you have not done so already, complete the initial installation steps in Prepare for installation on Amazon
Web Services alla pagina 927.

Nota:  There are many possible system configurations and requirements. These installation steps do not
account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.

To install the Control Room in a cluster setup, do the following steps:
1. Login to the first AWS instance as an Administrator.
2. Download Automation Anywhere_<version>.exe.
3. Fai clic su Avanti nella pagina di benvenuto della procedura guidata di installazione.
4. Accetta il contratto di licenza e fai clic su Avanti.
5. Seleziona l'opzione Personalizzazione e fai clic su Avanti.

Viene visualizzata la pagina Cartella di destinazione. Per impostazione predefinita, la cartella di
destinazione è C:\Program Files\Automation Anywhere\Enterprise\.

6. Per apportare modifiche alla cartella di destinazione, fai clic su Modifica, inserisci il nome della
cartella di destinazione e fai clic su OK.

Nota:  Non è consigliabile installare l'applicazione direttamente nella directory principale (C:
\). You should create a folder, for example, C:\Program Files\Automation Anywhere
\Enterprise\.

7. Click Next to configure the IP cluster.
8. Select the Enable Cluster Setup check box.

The check box is enabled by default if the machine on which the setup is being run has local IP
addresses configured.
To install the Control Room on a single node and not a cluster, clear the Enable Cluster Setup check
box.

9. Enter the IP addresses of the nodes in the cluster.
• Enter IPv6 addresses if all the nodes in the network are using IPv6.
• Enter IPv4 addresses if some nodes in the network are using a combination of IPv4 and IPv6

addresses.

a) Use a comma (,) to specify more than one IP address.
For example, to specify three IP addresses in the cluster, enter:
192.0.2.1,192.0.2.2,192.0.2.3

Importante:  The first IP address in the list is used as the master node. Ensure that you enter
the IP addresses in the same order on all node configurations in subsequent installations. An
incorrect order causes the application to configure the IP addresses as separate clusters, which
will result in data loss when the issue is fixed after installation.

You can install multiple nodes at the same time after the master node is initially installed.
After installation, you can add a new IP address to the cluster at the end of the list.

b) After you enter the cluster IP addresses correctly, select a valid address IP at the message prompt
to provide network access to the machine.

10. Click Next to configure the application Transport Layer Security (TLS).

© 2023 Automation Anywhere. All rights reserved.     929



    Automation Anywhere - Installazione e aggiornamento Automation 360

11. In the TLS Configuration page, configure the following:
• Generate a Self-Signed Certificate

Enabling the Self-Signed Certificate option allows the installer to generate a unique private key
and a self-signed certificate for the Control Room.

• Import a Certificate
To import a custom certificate, clear the Self Signed Certificate check box. This setting allows
you to import a certificate using the Certificate Path field.

Nota:  The certificate file must be a PKCS12 format.

Provide the following information:
• Certificate Path: Click Browse to import the certificate.
• Private Key Password: Enter the password for the private key.

Password limitation:  Do not use the at sign (@) in passwords. Using the special character @
in the password causes the certificate file import to fail.

• Webserver Port: Enter the web server port – either HTTP or HTTPS. If the port is already
assigned, an error message is displayed.

Importante:  The port validation message is also displayed when you add 8080 for the web
server and if that port is already in use for a Control Room license service. Use a different
unassigned port in these cases.

• Enable Force HTTP traffic to HTTPS: This option redirects all HTTP port requests to HTTPS.
To access to the Control Room through HTTPS using the generated self-signed certificate,
ensure the port numbers are different for HTTP and HTTPS.
To generate a custom certificate for HTTPS, ensure your custom certificate meets the following:
• Create a .pfx certificate with a pass code from a CA trusted authority.
• Combine Root, Intermediate, and Machine level certificates into a single certificate.
• Use the format [WS Machine Host Name].[DomainName].com for the private key.
• Include the host name as a fully qualified domain name (FQDN) in the certificate.

You provide the host name during Control Room installation.
• In multi-node HA clusters, issue certificates to the load balancer DNS name.
• Add individual URLs, which require access to all nodes, to the Subject Alternative

Name field in the certificate.

For more information, see Automation Anywhere support site: Automation 360 On-Premises
prerequisites (A-People login required).

12. Click Next to configure the service credentials.
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13. In the Service Credentials screen, choose from the listed options.
The Windows Service credentials include a user name and password. The user specified must meet
these requirements:
• A member of the local system administrator group.
• Have permission to manage services, including Automation Anywhere services.
• If you use Windows authentication to connect to the SQL database, ensure you grant the

db_owner permission to the service credential user.

These service credentials allow the Control Room processes to run the required services.
• Local System Account—(default) The logged-on user performing the installation
• Domain Account—Specify a user that is not the local system account user

a. Clear the Local System Account check box.
b. Enter the user name and password for the domain account.

Utilizza solo caratteri supportati per il nome utente e la password. Consulta Supported special
characters alla pagina 874.

• Do not use the Windows domain credentials
Enter credentials valid for running Automation Anywhere services. Without the valid credentials,
the Control Room will fail to launch.

• PowerShell script restrictions
Specify a user with permissions to launch PowerShell scripts who is not a Windows domain user.
Without the relevant permissions, database table creation can fail.

14. Add the SQL Server and click Next.
Select Microsoft SQL Server, type the Name, and click Next.

15. Nella pagina Installazione guidata InstallShield completata, fai clic su Fine.
Launch Automation Anywhere is enabled by default.
Abilita Mostra impostazioni programma di installazione per aprire il file aae-
installsummary.html. By default, this is located at C:\Program Files\Automation
 Anywhere\Enterprise\. Use this file to view a summary of the installation.

The Control Room launches in your default browser with the Configure Control Room settings page shown.
Continue with Configure settings post-installation on Amazon Web Services alla pagina 931.

Configure settings post-installation on Amazon Web Services
After installation is complete, configure Control Room settings on Amazon Web Services.
If you have not done so already, complete the installation steps in Customize Control Room installation on
Amazon Web Services alla pagina 928.

Nota:  There are many possible system configurations and requirements. These installation steps do not
account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.
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To install Automation Anywhere on Amazon Web Services (AWS), do the following steps:
1. Configure the following Control Room settings:

a) Specify the host name URL by providing the AWS Load Balancer URL.
This is the URL that users use to access your installation of Control Room.

b) Select the Active Directory authentication type. Per ulteriori informazioni, consulta Configure
Control Room for Active Directory: manual mode alla pagina 982.

2. After you configure the Control Room, install product licenses.
3. Test Control Room access using the AWS Load Balancer URL.

This completes the Control Room installation on AWS.

Complete the Control Room configuration and validation.
• Complete Control Room post-installation configuration alla pagina 965

After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.

• Post-installation user management alla pagina 979
After completing the post-installation tasks, validate the setup by logging in to the Control Room and
installing a license. First time access to the Control Room walks you through the configuration for your
authentication method.

• Utenti alla pagina 2683
In qualità di utente Cloud con autorizzazioni di amministratore, puoi creare, visualizzare, modificare,
eliminare, abilitare o disabilitare un utente. La creazione dei passaggi per gli utenti varia a seconda che
l'utente sia un utente non Active Directory, Active Directory o Single Sign On da un server IdP.

Installing Control Room on Microsoft Azure
Installing Control Room on Microsoft Azure begins in the Azure environment and ends with configurations
in the Control Room.

Nota:  There are many possible system configurations and requirements. These installation steps do not
account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.

Passaggio 1: Prepare for installation. • Verify Automation 360 On-Premises prerequisites
alla pagina 840.

• Assicurati di disporre di quanto segue:
• Automation Anywhere Control Room

installation file
• TLS certificate
• License file

Passaggio 2: Verify readiness for installation on
Microsoft Azure alla pagina 933

Use these steps to configure third-party products
for the Control Room installation.

Passaggio 3: Begin Control Room installation on
Microsoft Azure alla pagina 936

Initial steps for Control Room installation on
Microsoft Azure.
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Passaggio 4: Customize Control Room installation on
Microsoft Azure alla pagina 936

Install and apply the customized configuration
required for the Control Room cluster on Microsoft
Azure.

Passaggio 5: Complete Control Room
configuration and validation. Complete Control

Room post-installation
configuration alla
pagina 965

After installing the
Control Room, complete
the configuration
settings to ensure timely
Automation Anywhere
communications are
specified and confirm
Automation Anywhere
services are running.

Post-installation user
management alla pagina
979

After completing the
post-installation tasks,
validate the setup by
logging in to the Control
Room and installing a
license. First time access
to the Control Room
walks you through the
configuration for your
authentication method.

Passaggio 6: Prepare for users. Utenti alla pagina
2683

In qualità di utente
Cloud con autorizzazioni
di amministratore, puoi
creare, visualizzare,
modificare, eliminare,
abilitare o disabilitare un
utente. La creazione dei
passaggi per gli utenti
varia a seconda che
l'utente sia un utente
non Active Directory,
Active Directory o Single
Sign On da un server
IdP.

Verify readiness for installation on Microsoft Azure
Use these steps to configure third-party products for the Control Room installation.

Nota:  There are many possible system configurations and requirements. These installation steps do not
account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.
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To configure third-party products prior to installation, do the following steps:
1. Ensure the installation environment meets the data center requirements and collect the necessary

information about the following components:
• Load balancer - IP address
• Microsoft SQL Server - port credentials
• Azure SMB file share - address credentials
• Enterprise identity management system (optional)

If you have Active Directory (AD) - AD server domain credentials
• SMTP - host port HTTP/S ports for TLS (optional)
• Control Room servers - Have Windows credential manager installed

Refer to Versioni dei componenti del data center supportate in Microsoft Azure alla pagina 935 for
configuration and version information.

2. Configure the Network Security Group as per the recommended security policies for Inbound Port
rules:

Oggetto data center Porta Protocollo

Control Room • 80
• 443

Qualsiasi

LDAP • 3268
• 3269

Qualsiasi

e-mail SMTP 587 Qualsiasi

SSH 22 Qualsiasi

RDP 3389 TCP

3. Configure the AD server.
Ensure all users are part of the AD domain and the AD server is setup in IaaS mode for Azure cluster
environment installations. To add user, navigate to Active Directory Users and Computers >
<domain> > Users and add the necessary user.
To configure the AD server on Azure with IDaaS, refer to the Microsoft Azure documentation.
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4. Ensure the Control Room servers in the cluster can ping each other.
If the ping is not successful:
a) In Windows Defender Firewall with Advanced Security>Inbound rules, set the following

values for the file and printer sharing firewall rule:
• Nome: File and Printer Sharing (Echo Request - ICMPv4-In)
• Group: File and Printer Sharing
• Profile:All
• Enabled: Sì
• Action: Consenti
• Override: No
• Program: Qualsiasi
• Local address: Qualsiasi
• Remote address: Qualsiasi
• Protocol: ICMPv4

b) Ping the Control Room after enabling the firewall rule change.

When you have completed the pre-installation configurations, Begin Control Room installation on Microsoft
Azure alla pagina 936.

Versioni dei componenti del data center supportate in Microsoft Azure
For installing Automation Anywhere on the Microsoft Azure cluster environment, the versions of data center
components that are supported are identified for each component.

Oggetto data center Versioni supportate Configurazione

Sistema operativo Control Room • Data center 2012 e 2012 R2
Microsoft Windows Server

• Standard e data center 2016
Microsoft Windows Server

• Standard e data center 2019
Microsoft Windows Server

IaaS

Gestione delle identità: Azure
Active Directory

Azure Active Directory • IDaaS
• Windows 2016 per IaaS

SMB File Share Azure File Share con protocollo
Server Message Block 2.0 e 3.0
(SMB)

PaaS

Load Balancer Bilanciamento del carico Azure PaaS

Azure Application Gateway

Microsoft SQL Server Database SQL di Azure con
database singolo (Microsoft SQL
Azure (RTM) - 12.0.2000.8)

PaaS
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Begin Control Room installation on Microsoft Azure
Initial steps for Control Room installation on Microsoft Azure.
If you have not done so already, complete the pre-installation configuration in Verify readiness for
installation on Microsoft Azure alla pagina 933.

Nota:  There are many possible system configurations and requirements. These installation steps do not
account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.

To begin the installation:
1. Use Remote Desktop Connection (RDC) to connect to the Control Room server, as an Administrator,

and run the Control Room installer.
2. Click Yes to start the installer.
3. Fai clic su Avanti nella pagina di benvenuto della procedura guidata di installazione.
4. Accetta il contratto di licenza e fai clic su Avanti.
5. Seleziona l'opzione Personalizzazione e fai clic su Avanti.
6. Click Next to setup the system IPs.

The Cluster Configuration window displays.

Continue with Customize Control Room installation on Microsoft Azure alla pagina 936.

Customize Control Room installation on Microsoft Azure
Install and apply the customized configuration required for the Control Room cluster on Microsoft Azure.
If you have not done so already, complete the initial installation steps in Begin Control Room installation
on Microsoft Azure alla pagina 936. This task requires the configuration information you gathered in the
prerequisites stage. This includes IP addresses, certificates, and credentials for the the Control Room
servers, datacenter servers, and databases.

Nota:  There are many possible system configurations and requirements. These installation steps do not
account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.

Importante:  Automation 360 software components are not compatible with Distributed Resource
Scheduling (DRS) and Virtual Migration of Dynamic Processes across hosts. Ensure that you do not enable
the corresponding properties of the host virtual machines.

To install the Control Room in a cluster setup, do the following steps:
1. Select the Enable Cluster Setup check box.

The check box is enabled by default if the machine on which the setup is being run has local IP
addresses configured.
To install the Control Room on a single node and not a cluster, clear the Enable Cluster Setup check
box.
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2. Enter the IP addresses of the nodes in the cluster.
a) Use a comma (,) to specify more than one IP address.

For example, to specify three IP addresses in the cluster, enter:
192.0.2.1,192.0.2.2,192.0.2.3

Importante:  The first IP address in the list is used as the master node. Ensure that you enter
the IP addresses in the same order on all node configurations in subsequent installations. An
incorrect order causes the application to configure the IP addresses as separate clusters, which
will result in data loss when the issue is fixed after installation.

You can install multiple nodes at the same time after the master node is initially installed.
After installation, you can add a new IP address to the cluster at the end of the list.

b) After you enter the cluster IP addresses correctly, select a valid address IP at the message prompt
to provide network access to the machine.

3. Click Next to configure the application Transport Layer Security (TLS).
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4. In the TLS Configuration page, configure the following:
• Generate a Self-Signed Certificate

Enabling the Self-Signed Certificate option allows the installer to generate a unique private key
and a self-signed certificate for the Control Room.

• Import a Certificate
To import a custom certificate, clear the Self Signed Certificate check box. This setting allows
you to import a certificate using the Certificate Path field.

Nota:  The certificate file must be a PKCS12 format.

Provide the following information:
• Certificate Path: Click Browse to import the certificate.
• Private Key Password: Enter the password for the private key.

Password limitation:  Do not use the at sign (@) in passwords. Using the special character @
in the password causes the certificate file import to fail.

• Webserver Port: Enter the web server port – either HTTP or HTTPS. If the port is already
assigned, an error message is displayed.

Importante:  The port validation message is also displayed when you add 8080 for the web
server and if that port is already in use for a Control Room license service. Use a different
unassigned port in these cases.

• Enable Force HTTP traffic to HTTPS: This option redirects all HTTP port requests to HTTPS.
To access to the Control Room through HTTPS using the generated self-signed certificate,
ensure the port numbers are different for HTTP and HTTPS.
To generate a custom certificate for HTTPS, ensure your custom certificate meets the following:
• Create a .pfx certificate with a pass code from a CA trusted authority.
• Combine Root, Intermediate, and Machine level certificates into a single certificate.
• Use the format [WS Machine Host Name].[DomainName].com for the private key.
• Include the host name as a fully qualified domain name (FQDN) in the certificate.

You provide the host name during Control Room installation.
• In multi-node HA clusters, issue certificates to the load balancer DNS name.
• Add individual URLs, which require access to all nodes, to the Subject Alternative

Name field in the certificate.

For more information, see Automation Anywhere support site: Automation 360 On-Premises
prerequisites (A-People login required).

5. Click Next to configure the service credentials.
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6. In the Service Credentials screen, choose from the listed options.
The Windows Service credentials include a user name and password. The user specified must meet
these requirements:
• A member of the local system administrator group.
• Have permission to manage services, including Automation Anywhere services.
• If you use Windows authentication to connect to the SQL database, ensure you grant the

db_owner permission to the service credential user.

These service credentials allow the Control Room processes to run the required services.
• Local System Account—(default) The logged-on user performing the installation
• Domain Account—Specify a user that is not the local system account user

a. Clear the Local System Account check box.
b. Enter the user name and password for the domain account.

Utilizza solo caratteri supportati per il nome utente e la password. Consulta Supported special
characters alla pagina 874.

• Do not use the Windows domain credentials
Enter credentials valid for running Automation Anywhere services. Without the valid credentials,
the Control Room will fail to launch.

• PowerShell script restrictions
Specify a user with permissions to launch PowerShell scripts who is not a Windows domain user.
Without the relevant permissions, database table creation can fail.

7. Click Next to configure database type and server.
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8. Imposta la connessione e l'autenticazione per il server di database.

Nota:
• Se possibile, non impostare il valore per Server di database come localhost. Se è necessario

utilizzare localhost, tieni presente che la Connessione protetta al database non funzionerà.
• Fai clic sul pulsante Sfoglia per selezionare l'istanza di SQL Server in cui verrà creato il database

di Control Room. In alternativa, inserisci il nome di un server di database o selezionane uno
dall'elenco.

Attività della migrazione: Se stai eseguendo la migrazione da Enterprise 11 a Automation 360, vai
al database Enterprise 11 ripristinato.
Fornisci i seguenti dettagli:
a) Porta di database: Utilizza la porta predefinita (1433) o specifica un valore personalizzato.

Configure default database port alla pagina 914
b) Usa connessione sicura: Seleziona per utilizzare un certificato CA come specificato.

Nota:  Utilizza lo stesso nome host per il certificato e le connessioni al database.

c) Certificato: Questa opzione è abilitata quando si seleziona Usa connessione sicura. Sfoglia
per selezionare un certificato CA.
Import HTTPS,and CA certificates alla pagina 970

d) Autenticazione Windows: Questa opzione è selezionata per impostazione predefinita e
consente la connessione a SQL Server tramite l'autenticazione Windows.

Nota:  Se selezioni l'autenticazione Windows, l'utente che esegue lo strumento di installazione
viene utilizzato per verificare che il database esista, crearlo se necessario e assegnare db_owner
all'utente dell'account di servizio (NT Authority/System).

e) Autenticazione SQL Server: Select this option to use SQL Server authentication to connect to
the database. Indica il nome utente e la password corretti per l’autenticazione SQL.
Utilizza solo caratteri supportati per il nome utente e la password. Consulta Supported special
characters alla pagina 874. Non utilizzare punti e virgola ( ; ) nella password del database.

f) Nome del database della sala di controllo: Inserisci il nome del database di Control Room.
Attività della migrazione: Se stai eseguendo la migrazione da Enterprise 11 a Automation 360,
inserisci il nome del database ripristinato nel campo del database come mostrato nell'immagine
seguente:
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9. Fai clic su Avanti.
10. Su Pronto per installare il programma, fai clic su Installa e consenti il completamento del

processo di installazione.
11. Nella pagina Installazione guidata InstallShield completata, fai clic su Fine.

Launch Automation Anywhere is enabled by default.
Abilita Mostra impostazioni programma di installazione per aprire il file aae-
installsummary.html. By default, this is located at C:\Program Files\Automation
 Anywhere\Enterprise\. Use this file to view a summary of the installation.

The Control Room launches in your default browser with the Configure Control Room settings page shown.
Continue with Configure settings post-installation on Microsoft Azure alla pagina 941.

Configure settings post-installation on Microsoft Azure
After Control Room installation is complete, use the Microsoft Azure Portal to configure the clusters. Use
the Azure Portal to configure Windows credentials, Control Room settings for repository and URL, master
key for Credential Vault, Active Directory authentication, and optionally SMTP settings.
• If you have not done so already, complete the installation steps in Customize Control Room installation on

Microsoft Azure alla pagina 936.
• The service account user must have read and write access for the Azure data drive (SMB).

Nota:  There are many possible system configurations and requirements. These installation steps do not
account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.

1. From the Azure Portal where SMB File Share is setup, get the Connection String to retrieve following
parameters:
• Internet or network address
• Nome utente
• Password

2. Locate the Window Credential Manager on the control room server and click Add a Windows
Credential.
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3. Enter the credential information.

Nota:  Adding a user under Windows Credential Manager needs to be repeated on all the servers
used for testing in the cluster environment (Control Room, Clients/Devices).

4. Enter information and click Save and Continue.
Repository path is extracted from SMB File Share and Control Room access URL in is a load balancer
Public IP.

5. Copy the Master Key and save it (it will be needed to restart the services).
6. Select Express mode and click Save and Continue.
7. Enter the Active Directory authentication configuration information, including URL, Domain username,

and password, then click Check Connection. If settings are correct, click Next.
8. Enter the AD user created previously and click Check name in Active Directory. Upon validation,

click Save and Log in.
Create additional users as needed and create corresponding users in the Control Room.

9. Opzionale: Continue with installing other control room nodes in the cluster.
10. Perform the SMTP registration.

Nota:  A real SSL certificate is recommended for use with deployments.

This completes the Control Room installation on Microsoft Azure.

If you see a Bad Gateway error message after you install the Control Room in a three-node cluster setup
with S0 Azure SQL Database, see the following article for troubleshooting steps.
Automation A360 - Bad Gateway error in a three node cluster setup (A-people login required)

Complete the Control Room configuration and validation.
• Complete Control Room post-installation configuration alla pagina 965

After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.

• Post-installation user management alla pagina 979
After completing the post-installation tasks, validate the setup by logging in to the Control Room and
installing a license. First time access to the Control Room walks you through the configuration for your
authentication method.

• Utenti alla pagina 2683
In qualità di utente Cloud con autorizzazioni di amministratore, puoi creare, visualizzare, modificare,
eliminare, abilitare o disabilitare un utente. La creazione dei passaggi per gli utenti varia a seconda che
l'utente sia un utente non Active Directory, Active Directory o Single Sign On da un server IdP.

Installing Control Room on Google Cloud Platform
Log in to a Google Cloud Platform (GCP) server instance as administrator. Then download and start the
Control Room installer and install in Custom mode.
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Nota:  There are many possible system configurations and requirements. These installation steps do not
account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.

1. Complete the prerequisites for installation:
• Verify Automation 360 On-Premises prerequisites alla pagina 840.
• Assicurati di disporre di quanto segue:

• Automation Anywhere Control Room installation file
• TLS certificate
• License file

2. Prepare to install Control Room on Google Cloud Platform alla pagina 944
Ensure that you complete the required steps to prepare the Google Cloud Platform instances for
installing the Control Room.

3. Perform custom installation of Control Room on Google Cloud Platform alla pagina 945
Install and apply the customized configuration required for the Control Room cluster on Google Cloud
Platform after completing initial preparations.

4. Configure Google Cloud Platform settings after installation alla pagina 947
After installing the Control Room, configure the required settings on Google Cloud Platform.

5. Complete the Control Room configuration and validation.
a) Complete Control Room post-installation configuration alla pagina 965

After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.

b) Post-installation user management alla pagina 979
After completing the post-installation tasks, validate the setup by logging in to the Control Room
and installing a license. First time access to the Control Room walks you through the configuration
for your authentication method.

6. Manage your users

In qualità di utente Cloud con autorizzazioni di amministratore, puoi creare, visualizzare, modificare,
eliminare, abilitare o disabilitare un utente. La creazione dei passaggi per gli utenti varia a seconda
che l'utente sia un utente non Active Directory, Active Directory o Single Sign On da un server IdP.

Suggerimento:  To ensure that the bots run properly in GCP, we recommend that you create a
whitelist for the following APIs:
• /v2/repository/files/:id/content
• /v2/repository/files/public/:id/content
• /v2/blm/import
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Prepare to install Control Room on Google Cloud Platform
Ensure that you complete the required steps to prepare the Google Cloud Platform instances for installing
the Control Room.
1. Configure the Network Security Group of all the servers as specified in the following list:

• Name: aarestrictedsecuritygroup
• Type: Ingress
• Targets: aarestrictedsecuritygroup
• Filters: IP ranges: List of IP addresses provided by the IT security team
• Protocols and ports: all
• Action: Consenti
• Priority: 1000
• Network: default

Nota:  In the IP address ranges field, enter all the IP addresses of all the virtual machines (VMs) in
the cluster environment.

2. Set up the F5 load balancer with the following configurations:
• Select standard as the type option.
• Enter 0.0.0.0/0 as the Source address in Host.
• Enter F5-LB-Private IP as the Destination Address/Mask in Host.
• Enter 80 as the Port and select HTTP as the Service Port.
• Select the Notify Status to Virtual Address check box.
• Enable the load balancer state.

To use SSL offload with the F5 load balancer, provide the SSL certificate at the load balancer level,
and configure your Control Room application servers to use HTTP mode only.

Nota:  Your IT team should configure the F5 load balancer with the Control Room.

3. Set up pools and nodes with the following configurations:
a) Update the pool properties:

• Choose a basic configuration.
• Select ICMP as your gateway to monitor health.

b) Update the pool member options:
• Choose the round-robin method for load balancing.
• Disable the priority group activation.

c) Update the node properties:
• Change the state to enabled.
• Select node-specific health monitors.
• Select ICMP as your gateway to monitor health.

4. Configure the Active Directory server.
Verify that all the VMs in the cluster can ping each other using private IP addresses.
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5. Connect using RDP to one of the Control Room nodes or servers and run the Control Room installer.
The Installation Prerequisite Check verifies that your system has the basic configurations required for
Automation Anywhere. Consulta Automation 360 On-Premises prerequisites alla pagina 840.

Perform custom installation of Control Room on Google Cloud Platform alla pagina 945

Perform custom installation of Control Room on Google Cloud Platform
Install and apply the customized configuration required for the Control Room cluster on Google Cloud
Platform after completing initial preparations.
If you have not done so already, complete the initial installation steps: Prepare to install Control Room on
Google Cloud Platform alla pagina 944.
1. Log in to the first Google Cloud Platform instance as an administrator.
2. Download the Automation Anywhere__<version>.exe file.

A-People Downloads page (Login required)

3. Run the installer file.
4. Fai clic su Avanti nella pagina di benvenuto della procedura guidata di installazione.
5. Accetta il contratto di licenza e fai clic su Avanti.
6. Seleziona l'opzione Personalizzazione e fai clic su Avanti.

Viene visualizzata la pagina Cartella di destinazione. Per impostazione predefinita, la cartella di
destinazione è C:\Program Files\Automation Anywhere\Enterprise\.

7. Per apportare modifiche alla cartella di destinazione, fai clic su Modifica, inserisci il nome della
cartella di destinazione e fai clic su OK.

Nota:  Non è consigliabile installare l'applicazione direttamente nella directory principale (C:
\). You should create a folder, for example, C:\Program Files\Automation Anywhere
\Enterprise\.

8. Click Next to configure the IP cluster.
9. Select the Enable Cluster Setup check box.

The check box is enabled by default if the machine on which the setup is being run has local IP
addresses configured.
To install the Control Room on a single node and not a cluster, clear the Enable Cluster Setup check
box.

10. Enter the IP addresses of the nodes in the cluster.
• Enter IPv6 addresses if all the nodes in the network are using IPv6.
• Enter IPv4 addresses if some nodes in the network are using a combination of IPv4 and IPv6

addresses.

a) Use a comma (,) to specify more than one IP address.
For example, to specify three IP addresses in the cluster, enter:
192.0.2.1,192.0.2.2,192.0.2.3

Importante:  The first IP address in the list is used as the master node. Ensure that you enter
the IP addresses in the same order on all node configurations in subsequent installations. An
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incorrect order causes the application to configure the IP addresses as separate clusters, which
will result in data loss when the issue is fixed after installation.

You can install multiple nodes at the same time after the master node is initially installed.
After installation, you can add a new IP address to the cluster at the end of the list.

b) After you enter the cluster IP addresses correctly, select a valid address IP at the message prompt
to provide network access to the machine.

11. Click Next to configure the application Transport Layer Security (TLS).
12. In the TLS Configuration page, configure the following:

• Generate a Self-Signed Certificate
Enabling the Self-Signed Certificate option allows the installer to generate a unique private key
and a self-signed certificate for the Control Room.

• Import a Certificate
To import a custom certificate, clear the Self Signed Certificate check box. This setting allows
you to import a certificate using the Certificate Path field.

Nota:  The certificate file must be a PKCS12 format.

Provide the following information:
• Certificate Path: Click Browse to import the certificate.
• Private Key Password: Enter the password for the private key.

Password limitation:  Do not use the at sign (@) in passwords. Using the special character @
in the password causes the certificate file import to fail.

• Webserver Port: Enter the web server port – either HTTP or HTTPS. If the port is already
assigned, an error message is displayed.

Importante:  The port validation message is also displayed when you add 8080 for the web
server and if that port is already in use for a Control Room license service. Use a different
unassigned port in these cases.

• Enable Force HTTP traffic to HTTPS: This option redirects all HTTP port requests to HTTPS.
To access to the Control Room through HTTPS using the generated self-signed certificate,
ensure the port numbers are different for HTTP and HTTPS.
To generate a custom certificate for HTTPS, ensure your custom certificate meets the following:
• Create a .pfx certificate with a pass code from a CA trusted authority.
• Combine Root, Intermediate, and Machine level certificates into a single certificate.
• Use the format [WS Machine Host Name].[DomainName].com for the private key.
• Include the host name as a fully qualified domain name (FQDN) in the certificate.

You provide the host name during Control Room installation.
• In multi-node HA clusters, issue certificates to the load balancer DNS name.
• Add individual URLs, which require access to all nodes, to the Subject Alternative

Name field in the certificate.

For more information, see Automation Anywhere support site: Automation 360 On-Premises
prerequisites (A-People login required).

13. Click Next to configure the service credentials.
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14. In the Service Credentials screen, choose from the listed options.
The Windows Service credentials include a user name and password. The user specified must meet
these requirements:
• A member of the local system administrator group.
• Have permission to manage services, including Automation Anywhere services.
• If you use Windows authentication to connect to the SQL database, ensure you grant the

db_owner permission to the service credential user.

These service credentials allow the Control Room processes to run the required services.
• Local System Account—(default) The logged-on user performing the installation
• Domain Account—Specify a user that is not the local system account user

a. Clear the Local System Account check box.
b. Enter the user name and password for the domain account.

Utilizza solo caratteri supportati per il nome utente e la password. Consulta Supported special
characters alla pagina 874.

• Do not use the Windows domain credentials
Enter credentials valid for running Automation Anywhere services. Without the valid credentials,
the Control Room will fail to launch.

• PowerShell script restrictions
Specify a user with permissions to launch PowerShell scripts who is not a Windows domain user.
Without the relevant permissions, database table creation can fail.

15. Add the SQL Server and click Next.
Select Microsoft SQL Server, enter the name, and click Next.

16. Nella pagina Installazione guidata InstallShield completata, fai clic su Fine.
Launch Automation Anywhere is enabled by default.
Abilita Mostra impostazioni programma di installazione per aprire il file aae-
installsummary.html. By default, this is located at C:\Program Files\Automation
 Anywhere\Enterprise\. Use this file to view a summary of the installation.

The Control Room is opened in your default browser and displays the Configure Control Room settings
page.
Configure Google Cloud Platform settings after installation alla pagina 947

Configure Google Cloud Platform settings after installation
After installing the Control Room, configure the required settings on Google Cloud Platform.
If you have not done so already, complete the installation steps: Perform custom installation of Control Room
on Google Cloud Platform alla pagina 945.
1. Configure the following Control Room settings:

a) Specify the host name URL by providing the Google Cloud Platform load balancer URL.
This is the URL that users use to access the Control Room.

b) Select the Active Directory authentication type.
Consulta Configure Control Room for Active Directory: manual mode alla pagina 982.
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2. After you configure the Control Room, install product licenses.
3. Test access to the Control Room using the Google Cloud Platform load balancer URL.

Complete the Control Room configuration and validation.
• Complete Control Room post-installation configuration alla pagina 965

After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.

• Post-installation user management alla pagina 979
After completing the post-installation tasks, validate the setup by logging in to the Control Room and
installing a license. First time access to the Control Room walks you through the configuration for your
authentication method.

• Utenti alla pagina 2683
In qualità di utente Cloud con autorizzazioni di amministratore, puoi creare, visualizzare, modificare,
eliminare, abilitare o disabilitare un utente. La creazione dei passaggi per gli utenti varia a seconda che
l'utente sia un utente non Active Directory, Active Directory o Single Sign On da un server IdP.

Installing Control Room on Linux
You start installing the Automation Anywhere Control Room in the Linux environment and complete the
installation in the Control Room.

Nota:  The installation steps do not list any specific configurations or requirements and therefore your
setup might be different. Automation Anywhere does not provide any warranties that the installation steps
conform with your system configurations or requirements.

This task applies to first-time installation and updates of Automation 360 On-Premises.

Ensure the following:
• The Microsoft SQL Server or Oracle Server database is installed and running.
• The Automation 360 installation server is connected to the Microsoft SQL Server or Oracle Server

database.
• For Oracle Server, ensure that you have installed the appropriate JDBC driver for the Oracle version that

is connected to the Control Room.
• From Automation 360 Build 6463, ensure that Python 3.6 is installed.
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• For Oracle Server, only non-container database is supported.

1. Verify the installation prerequisites.
a) Verify the Automation 360 On-Premises prerequisites alla pagina 840.
b) Depending on the server you want to use, verify that the Microsoft SQL Server or Oracle Server is

running, and execute the command:
$ sudo systemctl status mssql-server

If Microsoft SQL Server is not running, install it.

Nota:  The Microsoft SQL Server or Oracle Server installation instructions refer to Red Hat
Enterprise Linux version 8. For version 7, change the paths to /rhel/7 instead of /rhel/8.

Consulta Quickstart: Install SQL Server.
c) Ensure the following files are available:

• SSL certificate
• License file

d) Download the Automation360_el7_Build_<build_number>.bin installation file to the
Linux server from A-People Downloads page (Login required)

Nota:  We do not support the patch upgrades (upgrading between builds in the same release) in
Linux. When you are performing a patch upgrade, we recommended that you always uninstall and
do a fresh install for the patch upgrades.

e) Verify that the installation server has internet access in order to update Linux kernel files and OS
libraries using Yum updates.
Alternatively, configure /etc/yum.conf on the installation server to use a Yum repository local
to its network. The Yum repository should be up to date before starting the installation.

f) Starting in Automation 360 Build 6463, Python 3.6 is required.

2. Log in to the installation server.
3. Run the installer command as a superuser from the Linux shell:

a) $ sudo chmod +x Automation360_el7_Build_<build_number>.bin

b) $ sudo ./Automation360_el7_Build_<build_number>.bin

The installation wizard verifies the installation requirements and proceeds with the installation.

Suggerimento:
• Enter the back command to return to a previous command step.
• Press the return key to accept default values, or enter an alternate value and then press the

return key.

4. To accept the license agreement, enter Y.
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5. In the Transport Layer Security (TLS) screen, configure the following:
a) Control Room HTTP Port (Default: 80)

b) Control Room HTTPS Port (Default: 443)

c) To enable the Self Signed Certificate, enter 1 or enter 2 to disable it.
d) To Force HTTP Traffic to HTTPS, enter 1 to disable it or enter 2 to enable it.

Configure application Transport Layer Security alla pagina 907
6. In the Cluster Configuration screen, enter 1 to disable it or enter 2 to enable it.

• If you choose to enable cluster configuration, enter the IP addresses of the cluster nodes. Use
a comma (,) to specify more than one IP address. Do not add space between IP addresses. Ad
esempio: 192.168.0.1,192.168.0.2,192.168.0.3

• The repository location should be a shared location accessible from all Control Room nodes in the
cluster.

• Ensure that you select the IP address that is used to communicate with other nodes of the Control
Room.

Configura cluster IP alla pagina 917
7. In the Database Type screen, select one of the following servers:

• Microsoft SQL Server
• Oracle

8. Depending on the database server you chose, configure the following settings the server:

Microsoft Databse Configuration Oracle Databse Configuration

Database Server address
 (default: localhost)

Database Server (default:
 localhost)

Database port (default: 1433) Database port (default: 1521)

Control Room Database (default:
Automation360-Database) or enter a
name.

Connect with SID or Service Name

Nota:  The SID and Service Name entered
in the text field provided is unique to your
Oracle database.

SQL Server Login credentials:
provide the login ID and SQL Server
password.

Database User/Schema Password:
provide the password.

Password prompt for
 elasticsearch: Enter or define any
password.

(Optional) Use Secure Connection:
Enable to use a CA certificate as specified
and select a CA certificate.

Nota:  Utilizza lo stesso nome host per il
certificato e le connessioni al database.

Import HTTPS and CA certificates
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9. In the Database Configuration screen, configure the following:
a) Database Server address (default: localhost)

b) Database port (default: 1433)

c) Control Room Database (default: Automation360-Database) or enter a name.
d) SQL Server Login credentials: provide the login ID and SQL Server password.
e) Password prompt for elasticsearch: Enter or define any password.

10. Review the pre-installation summary.
11. Press Enter to install Automation 360 in the default directory.

Linux installer Versione Default directory path

Version .22 and earlier
versions

Updating from earlier
versions to version .22

/opt/
automationanywhere/
enterprise

Installation file path

New installation of
version .22 and later

/opt/
automationanywhere/
automation360

A message appears stating the installation is successfully completed. See Installed Control Room
directories and files alla pagina 1002 for the location of control room assets.

12. Configure the post-installation settings.
Configuring post-installation settings alla pagina 966
Post-installation, a Control Room group controlroom is automatically created. Following users are a
part of this group which run the respective Control Room services:
crkernel, traefik, ignite, activemq, crelasticsearch, criqbot, crbotinsight,
craari, crdiscoverybot, crstorage, crdiscoverybotml.

13. Verify Automation 360 services started successfully.
Stop and start Control Room services on Linux alla pagina 2795

14. Set up Control Room access.
Configurazione del database della Control Room alla pagina 990

15. Set up licenses.
Installazione di licenze aggiuntive alla pagina 2794

16. The log files for the Control Room installation are available at:

Linux installer Versione Log file path

Version .22 and earlier
versions

Updating from earlier
versions to version .22

/var/log/
automationanywhere/
enterprise

Log path

New installation of
version .22 and later

/var/log/
automationanywhere/
automation360

After the Control Room installation and configuration is complete, users can register their devices to create
and run bots.
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Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039
For more information on Out of Memory Management (OOM Killer), see Linux Automation 360 Control Room
service stopped (A-People login required).
Attività correlate
Performing silent installation of Control Room on Linux alla pagina 952
Silent Control Room installation, also known as unattended installation, uses a customized script with
parameters specific to your business requirements. The entire installation process runs in the background
without requiring user interaction or displaying messages.
Uninstall Automation 360 On-Premises from Linux server alla pagina 955
Uninstall the On-Premises Control Room from your Linux server.
Riferimenti correlati
Installing Control Room On-Premises alla pagina 838
Review the installation core tasks and topics for installing the Automation 360 Control Room in a data
center on an On-Premises server or a cloud service provider server instance.
Requisiti dell'archivio Control Room alla pagina 865
La posizione dell'archivio viene configurata in Control Room dopo l'installazione. Tutte le automazioni
vengono memorizzate in questo archivio.

Performing silent installation of Control Room on Linux
Silent Control Room installation, also known as unattended installation, uses a customized script with
parameters specific to your business requirements. The entire installation process runs in the background
without requiring user interaction or displaying messages.
• Verify you have completed the Automation 360 On-Premises prerequisites alla pagina 840.
• Assicurati di disporre di quanto segue:

• Automation Anywhere Control Room installation file
• SSL certificate
• License file

• Verify the installation server has internet access in order to update Linux kernel files and OS libraries
using Yum updates. Alternatively, configure /etc/yum.conf on the installation server to use a
repository local to its network. The repository should be up to date before starting the installation.

Two scripts run the Linux silent installation:
• LinuxInstaller.sh: This script contains the installation parameters you want to apply during

installation.
• CallLinuxScript.sh: This script executes the first script.

See the installation parameters and sample scripts.
Run the script in Linux shell.
1. Review the parameters and identify the settings you require.

Control Room installation parameters

Installation parameter Descrizione Script response options

Proceed with Installation The installer analyzes your
system and notifies you
if it does not meet the
prerequisites. In silent mode,
set the value to 1.

1 = Continue
2 = Cancel
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Control Room installation parameters

Installation parameter Descrizione Script response options

Continue setup wizard The installer displays an
introduction and offers
options of back to return to
a previous step and quit to
cancel the installation.
Default is Enter.

\n

Advance to end of License
Agreement

In console mode, you have
the option to page through
the license agreement. In
silent mode, you advance to
the end by selecting 0.

0

Accept License Agreement Accept the license
agreement to continue with
the installation. In silent
mode, set the value to Y.

Y = Yes
N = No

Control Room HTTP Port The web server port you will
use to access the Control
Room with HTTP. The default
value is 80.
Replace the number 80 in
the sample script to use a
different port.

80 = Default port
yy = your port number yy

Control Room HTTPS Port The web server port you will
use to access the Control
Room with HTTPS. The
default value is 443.
Replace the number 443 in
the sample script to use a
different port.

443 = Default port
zzz = your port number zzz

TLS configuration: Self-
Signed Certificate

Choose to enable or disable
the self-signed certificate.
The default is Enable, or 1.

1 = Default (Enable)
2 = Disable

TLS Configuration: Force
HTTP traffic to HTTPS

Choose to disable or enable
forcing traffic from HTTP
to HTTPS. The default is
Disable.

1 = Default (Disable
2 = Enable

Cluster setup Choose to disable or enable
clustering. The default is
Disable.

1 = Default (Disable)
2 = Enable

Database server URL server1.yourcompany.com Enter the URL of the server
where the database resides.

Database server port Default is 1433 1433
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Control Room installation parameters

Installation parameter Descrizione Script response options

Nome database Default is localhost Default is localhost. If
database is on a separate
server, enter the host name.

Database SA user name Database system
administrator login ID

Default is sa.

Database SA user password Database system
administrator login ID

The password to log in to
your database as system
administrator user.

Database Secure Connection Choose to disable or enable
the connection. Default is
Disable (1).

1 = Default (Disable)
2 = Enable

Pre-Installation summary If the output is directed to
a console, the installer will
show a summary of features
selected and whether the
prerequisites are met.
Default is Enter

\n

Proceed Confirm to proceed with
the installation. Default is
Enter.

\n

2. Create the script LinuxInstaller.sh, substituting values for your own environment.

Importante:  Be sure to test the connection to the SQL Server and enter verified values for database
name, database administrator login ID, database administrator password. Invalid values cause the
script to stall and fail.

Example script:

echo "Starting Installation"
#Change the next two lines to match the install filename you downloaded
sudo chmod a+x AutomationAnywhereEnterprise_A2019_el7_4799.bin 
sudo ./AutomationAnywhereEnterprise_A2019_el7_4799.bin  << EOF
1
\n
0
Y
80
443
1
1
1
#Change the next line to your Automation Anywhere install server
mybotserver.mycompany.com
1433
#Replace next line with your database name
AAE-Database
#Change the next two lines to your SQL Server admin ID and password
admin
youradminpasswordhere
1
\n
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\n
\n
EOF

3. Create the script CallLinuxscript.sh to execute Linuxinstaller.sh.
This script writes the installation results to /home/Installlog. Change the path to the install log
file, if required.

echo "Starting Linux installation"
sudo ./LinuxInstaller.sh >> /home/Installlog
echo "Installation Completed Successfully"

4. On the installation server, logged in as an Administrator, execute the scripts.
a) $ sudo chmod a+x LinuxInstaller.sh

b) $ sudo chmod a+x CallLinuxscript.sh

c) $ sudo ./CallLinuxscript.sh

5. Review the installation log to confirm there were no errors.

Nota:  The Control Room installation folder on Linux is located by default at /opt/
automationanywhere/enterprise.

Continue from the step Configure the post-installation settings in
Installing Control Room on Linux alla pagina 948.

Uninstall Automation 360 On-Premises from Linux server
Uninstall the On-Premises Control Room from your Linux server.
Ensure that the Automation 360 installation server is disconnected from the Microsoft SQL Server
database.
1. Log in to the installation server.
2. Run the uninstaller command as a superuser:

$ sudo /opt/automationanywhere/enterprise/_Automation\ Anywhere\
 Enterprise_installation/Change\ Automation\ Anywhere\ Enterprise\
 Installation

The installation wizard verifies the installation and proceeds with the uninstallation.

Suggerimento:
• Enter the back command to return to a previous command step.
• Press the return key to accept default values, or enter an alternate value then press the return

key.

3. Confirm the uninstallation by entering Y.
The Automation 360 components are removed from the Linux system.
The databases with associated Automation 360 information about users and bots remains stored in
the database and remain connected to any other Control Room in your cluster.
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Performing silent uninstallation of Control Room on Linux
Use the sample script to perform an unattended uninstallation of Control Room.
Ensure that the Automation 360 installation server is disconnected from the Microsoft SQL Server
database.
1. Log in to the installation server.
2. Create a shell script named LinuxUninstall.sh that will run the uninstallation process and

automatically respond to prompts:

sudo /opt/automationanywhere/enterprise/_Automation\ Anywhere\
 Enterprise_installation/Change\ Automation\ Anywhere\ Enterprise\
 Installation << EOF
\n
1
\n
EOF

3. Mark the script as executable and run the uninstallation process.
a) $ sudo chmod a+x LinuxUninstall.sh

b) $ sudo ./LinuxUninstall.sh

The script is executed:

===============================================================================
Automation Anywhere Enterprise                   (created with
 InstallAnywhere)
-------------------------------------------------------------------------------
Preparing CONSOLE Mode Uninstallation...

===============================================================================
Uninstall Automation Anywhere Enterprise
----------------------------------------

About to uninstall...

4. When the uninstallation is complete, manually remove any remaining files.

Configure Control Room in cluster setup with shared repository for Linux
As an RPA platform administrator, you can configure the Control Room in a cluster setup across a shared
repository to achieve high availability, load balancing, and disaster recovery.
• Verify whether the prerequisites for on-premises installation are met.

Automation 360 On-Premises prerequisites alla pagina 840
• Assicurati di disporre di quanto segue:

• Three Linux VMs with RHEL 7.9
• One Linux VM with MS SQL 2019 connected to a database
• One load balancer with access to all the nodes
• One AWS NFS

If one of the Control Room nodes is down, the other nodes maintain continuity of service and manage
the load on the server. If a specific node fails, data can be recovered from the other shared nodes on the
server.
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Perform the following steps to configure the Control Room in a cluster that has three nodes (N1, N2, and
N3) using a shared repository.
1. Set up the NFS in AWS.
2. Create a directory in the nodes N1, N2, and N3.

/CRRepo/AutomationAnywhere

3. Run the following commands to grant the read and write permissions to the new directory across all
the nodes:
a) sudo chown -R crkernel:controlroom /CRRepo/AutomationAnywhere

b) sudo chmod -R 775 /CRRepo/AutomationAnywhere

4. Run the following command in all the three nodes to edit the fstab file to mount and map the new
directory with NFS.
fs-eec88e3f.efs.ap-south-1.amazonaws.com:/ /CRRepo/AutomationAnywhere nfs
 rw,hard,intr,rsize=1048576,wsize=1048576,timeo=14 0 0

5. To verify that the remote NFS volume is successfully mounted, reboot nodes N1, N2, and N3, and run
the df -h command.
After the share is mounted, the mount point becomes the root directory of the mounted file system.

6. To verify that the NFS is working across the shared repository, create a text file in the /CRRepo/
AutomationAnywhere directory of node N1.
You can view the same file in the nodes N2 and N3 directory.

7. Install Control Room in the nodes N1, N2, and N3.
Installing Control Room on Linux alla pagina 948

After Control Room is configured across the shared repository, perform the following steps:
1. Access Control Room through the load balancer URL.
2. Continue with the following steps after the Control Room configuration steps.

a. In the Control Room repository path, enter /CRRepo/AutomationAnywhere.
b. In the URL field, enter the load balancer server URL.
c. Complete steps required to create an admin user.

3. Verify the Control Room on all the three nodes by navigating to the Administration > Settings >
General tab.

Add nodes to a cluster setup for Linux
As an RPA platform administrator, you can add nodes to a cluster for better performance and better load
distribution.
Ensure the following:
• Verify whether the prerequisites for on-premises installation are met.

Automation 360 On-Premises prerequisites alla pagina 840
• Verify that all the primary nodes and databases have backups.
• You must have the IP addresses of all the cluster members for the Control Room server network

interfaces used for Elasticsearch communications.

Nota:  The Control Room servers can have multiple network interfaces. The server IP addresses must
be statically assigned and cannot use the Dynamic Host Configuration Protocol (DHCP).
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• If any external load balancers are used in the environment, update them with IP addresses from the
new server nodes.

• Ensure that you have administrator or root privileges on the Control Room servers. You must be familiar
with installing Control Room in custom mode and also with the related configuration settings.

Adding nodes to a cluster helps you to upgrade the configuration of the nodes in a cluster. You can add
nodes to a Control Room cluster setup, change the IP addresses of nodes in the cluster, and monitor the
health of the underlying cluster services.

Nota:  The minimal number of nodes supported within a Control Room cluster is three. The nodes in a
cluster synchronize with each other over a local network. All the nodes in a cluster connect to the same
database.

Perform the following steps to add three nodes (N4, N5, and N6) to a cluster that has three nodes (N1, N2,
and N3).
1. On node N4, run the installer command as a superuser from the Linux shell:

$ sudo ./Automation360_el7_Build_<build_number>.bin

2. Proceed through the installer to the cluster configuration.
a) Select Enable Cluster Setup.
b) In the Cluster IP addresses box, enter the IP addresses of all the nodes that you need to

configure in the cluster.

172.31.30.120, 172.31.21.216, 172.31.17.110, 172.31.20.242, 172.31.17.149,
 172.31.18.37

Nota:  The IP addresses must be entered in the same sequence on every node.

3. Complete the remaining steps to install Control Room.
Installing Control Room on Linux alla pagina 948

4. Repeat the steps 1 alla pagina 958 through 3 alla pagina 958 for nodes N5 and N6.
5. Add the complete set of IP adrresses for all the nodes in the older nodes N1, N2, and N3.

Restart the nodes, one at a time.
6. To verify the health of the cluster, run the following commands in the command line:

a) curl -k --user es_client:<es password> https://172.31.30.120:47599/_cat/
nodes

The master node is indicated by an asterisk character (*).
b) Verify that the IP address of the master node is the same as the one mentioned in the

elasticsearch.yml file for all the nodes.
c) curl -k --user es_client:<es password> https://172.31.30.120:47599/_cat/

health?pretty

You must wait until the replication status turns green. The replication time varies depending on the
data load in the clusters. The replication status turns green when the cluster is fully synchronized.

Remove nodes from a cluster setup for Linux
As an RPA platform administrator, you can remove nodes from a Control Room cluster setup to replace
them or upgrade them for enhanced performance.
Ensure the following:
• Verify that all the primary nodes and databases have backups.

© 2023 Automation Anywhere. All rights reserved.     958



    Automation Anywhere - Installazione e aggiornamento Automation 360

• Ensure that you have administrator or root privileges on the Control Room servers.

Perform the following steps to remove three nodes (N1, N2, and N3) from a cluster that has six nodes (N1,
N2, N3, N4, N5, and N6).
1. Run the following command in the Linux shell to identify the master node.

curl -k --user es_client:Automation123 https://172.31.46.2:47599/_cat/nodes

2. Remove the non-master nodes N2 and N3 from the cluster.
a) Log in to the server as an administrator and run the following command to stop all the Control

Room services.
sudo systemctl stop controlroom*

b) Log in to any of the non-master nodes.
c) Edit the cluster.properties file located at /opt/automationanywhere/automation360/

config.
d) Remove the IP addresses for the original three nodes.

Nota:  Perform this action for all the nodes in the cluster. When you remove the IP addresses of
the original three nodes, do not change their sequence.

e) Edit the elasticsearch.yml file at /opt/automationanywhere/automation360/
elasticsearch/config.

f) Remove the old IP addresses from the list in the discovery.zen.ping.unicast.hosts attribute.
g) Restart the non-master nodes, one at a time.

3. Remove the master node N1 from the cluster.
a) Log in to the server as an administrator and run the following command to stop all the Control

Room services.
sudo systemctl stop controlroom*

b) Log in to the any of the non-master nodes.
c) Edit the cluster.properties file and remove the IP address of the old master node.
d) Run the following command in any of the other nodes to identify the new master node.

curl -k --user es_client:<es password>https://172.31.18.37/_cat/nodes

e) Edit the elasticsearch.yml file at /opt/automationanywhere/automation360/
elasticsearch/config.

f) Update the IP address of the new master node in the cluster.initial_master_nodes attribute.
g) Remove the IP address of the old master node from the list in the

discovery.zen.ping.unicast.hosts attribute.
h) Run the following command to start the services on each node:

sudo systemctl start controlroom*

4. To verify the health of the cluster, run the following command in the command line:
curl -k --user es_client:<es password>https://172.31.18.37/_cat/nodes

You must wait until the replication status turns green. The replication status turns green when the
cluster is fully synchronized.
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Installing Control Room on Microsoft Windows Server using scripts
Silent Control Room installation, also known as unattended installation, uses a customized script for a full
setup or an update setup. Silent installation runs the entire installation process in the background, without
requiring user interaction or displaying messages.
To perform the task, you must have a  administrator account with the required rights and permissions.
• Disable the User Access Control (UAC) on host VM for Control Room.
• Verify Automation 360 On-Premises prerequisites alla pagina 840.
• Assicurati di disporre di quanto segue:

• Automation Anywhere Control Room installation file
• TLS certificate
• License file

• Create a Powershell script.
See the installation parameters and sample scripts.

• Run the script in Powershell.

1. Review the parameters and identify the settings you require.
• Control Room installation parameters

Variable name Descrizione

AA_CRCLUSTERCONFIG if AA_SETCLUSTERMODE=1 then cluster
IP comma separated

AA_CRDBPORT Control Room database port. Default
value is 1433

AA_CRDBSSLMODE Secure SQL connection

AA_CRFORCEHTTPSCONFIG=" " --

AA_CRFORCETOHTTPS="1" Force traffic from HTTP to HTTPS

AA_CRHTTPPORT Control Room HTTP port. Default is 5432

AA_CRHTTPSPORT Control Room HTTPS port

AA_CRLISTENPORT Web server port. Default value is 80

AA_CRSERVICECONFIRMPASSWD If AA_CRSETLOCALSERVICECRED= 0,
then confirm password

AA_CRSERVICEPASSWD If AA_CRSETLOCALSERVICECRED= 0,
then confirm password

AA_CRSERVICEUSERNAME if AA_CRSETLOCALSERVICECRED= 0,
then add domain\user name

AA_CRSETLOCALSERVICECRED • 1 if service logon as System
• 0 if service logon as specific user
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Variable name Descrizione

AA_CRWCCERTPASSWD Certificate password

AA_CRSELFSIGNCERT 1 for self-signed certificate

AA_CRWCCERTPATH Certificate path

AA_SDSFEATURE • true=Cloud deployment type
• false=On-Premises deployment type

AA_SETCLUSTERMODE For cluster set 1, otherwise 0

AA_SETUPTYPE Setup type Custom or Express

INSTALLDIR Installation Directory

IS_SQLSERVER_AUTHENTICATION • 0 for Windows authentication
• 1 for SQL authentication
• 2 for Azure AD authentication

IS_SQLSERVER_DATABASE SQL database name

IS_SQLSERVER_SERVER SQL server name (host name)

• Elasticsearch related parameters

Parametro Descrizione

AA_ELASTICSEARCH_BACKUP Used only if installing on the first node of
a backup server.
Enter 1 if yes.

Nota:  The
AA_ELASTICSEARCH_BACKUP parameter
is used when you install an Control Room
as backup server for audit.

AA_ELASTICSEARCHSYSIP Valid IP address

AA_ESPASSWD Password for Elasticsearch

Nota:  An additional parameter for
confirming the password is not available.
The password must have a minimum of 6
characters.
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• Key-vault related parameters

Parametro Descrizione

AA_KEYVAULTTYPE Enter any of the following:
• NONE if you do not want to define a

key vault
• AWSS for AWS Secrets Manager
• CARK for CyberArk

IS_SQLSERVER_AUTHENTICATION Enter any of the following:
• 0 if SQL server authentication is not

set
• 1 if SQL server authentication is set

IS_SQLSERVER_EKVAUTHENTICATION Use this if the SQL server authentication
is configured for an external key vault.
Enter any of the following:
• 0 if SQL server authentication does

not use an external key vault
• 1 if SQL server authentication for a

key vault is configured for CyberArk
• 2 if SQL server authentication for

a key vault is configured for AWS
Secrets Manager

AA_CRSERVICECREDTYPE Enter any of the following:
• LOCAL if the Control Room database

uses local authentication.
• SERVICE if the Control Room

database uses custom authentication.
• SERVICEEKV if the Control Room

database uses external key vault for
authentication.

AWS Secrets Manager key vault parameters

AA_AWSSREGION AWS region

AA_DBAUTHAWSSECRET AWS sqllogin secret

AA_CRSERVAWSSECRET AWS service secret

CyberArk key vault parameters

AA_CARKAPPID CyberArk app ID

AA_CARKCERTIFICATE Full certificate filename with path

AA_CARKOPTIONALCERT Optional certificate filename with path

AA_CARKCERTPASSPHRASE Certificate passphrase

AA_CARKVAULTURL CyberArk URL

AA_DBAUTHCARKOBJECTNAME CyberArk sqllogin object name
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Parametro Descrizione

AA_DBAUTHCARKSAFENAME CyberArk sqllogin safe name

AA_CRSERVCARKOBJECTNAME CyberArk service credential

AA_CRSERVCARKSAFENAME CyberArk service locker

• IPv6-related parameters

Parametro Descrizione

AA_IPV6ENABLED Enter 1 to enable IPv6 addresses
To disable IPv6 addresses, do not enter
the parameter.

2. Opzionale: Edit the sample script to use a Microsoft SQL Server database.
Use the script to install the Control Room with the configuration options available in the installer.
a) Correct values for variables such as $service_username, $service_pwd, $db_server,

$cr_port.
b) Run the script with Credentials in Service logon, and a non-secure connection using Microsoft SQL

Server authentication with a new database.

Sample script:

$cr_port=80

$service_username= "domain\username" #e.g."aaspl-brd\ellie.brown"
$service_pwd="password"

#$certpath = "C:\SilentInstall\test256.pfx"
#$certpass = "changeit"

$db_server="localhost"
$cr_db_name="CRDB-NEW-SI-3"
$db_user="sa"
$db_pwd="Admin@123"

$elastic_password="Test@123"

$installation_path="C:\Program Files\Automation Anywhere"

#Install latest setup
$static_installation_path="\Enterprise\"""""
$silent_details=" /s ","v""" -join "/"
$installpath_details=" /qn INSTALLDIR=\"""

$deployment_details=" /AA_SDSFEATURE=true"

$custom_details=" /vAA_SETUPTYPE=Custom 
                  /vAA_CUSTOMMODETYPE=1"

$port_cluster_details=" /vAA_SETCLUSTERMODE=0 
                        /vAA_CRLISTENPORT=$cr_port"

#$service_details=" /vAA_CRSETLOCALSERVICECRED=0 
                    /vAA_CRSERVICEUSERNAME=$service_username 
                    /vAA_CRSERVICEPASSWD=$service_pwd 
                    /vAA_CRSERVICECONFIRMPASSWD=$service_pwd"
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$service_details=" /vAA_CRSETLOCALSERVICECRED=1"

#$db_details=" /vAA_BIMETADATADBTYPE=AA_BIMETADATADBTYPE 
               /vIS_SQLSERVER_SERVER=$db_server 
               /vIS_SQLSERVER_DATABASE=$cr_db_name 
               /vIS_SQLSERVER_DATABASE1=$bi_db_name"

$db_details=" /vIS_SQLSERVER_SERVER=$db_server 
              /vIS_SQLSERVER_USERNAME=$db_user 
              /vIS_SQLSERVER_PASSWORD=$db_pwd 
              /vIS_SQLSERVER_DATABASE=$cr_db_name 
              /vIS_SQLSERVER_AUTHENTICATION=1"

$other=" /vAA_ESPASSWD=$elastic_password 
         /vAA_CRWCHTTPPORT=80 
         /vAA_CRWCHTTPSPORT=443 
         /vAA_CRSELFSIGNCERT=1 
         /vAA_OPTIONALCACERT=0 
         /vAA_CRWCCERTPATH=$certpath 
         /vAA_CRWCCERTPASSWD=$certpass 
         /vLAUNCHPROGRAM=1 
         /v""
         /LIweamoruc! log.txt"""

$final_commandline = -join($silent_details,
 $installpath_details,$installation_path,
 $static_installation_path,$custom_details,
 $port_cluster_details,$service_details,
 $db_details,$pg_details,$other)

Write-Host $final_commandline
$a=Get-ChildItem $PSScriptRoot\* -Include *.exe
#$a = "C:\Silent\AutomationAnywhereEnterprise_A2019_<build>.exe"

Write-Host $a
Write-Host "Starting the installation wait for sometime..."

$processdetail=(Start-Process -FilePath 
 $a -ArgumentList $final_commandline 
  -Wait -PassThru).ExitCode

Write-Host $a.Name execution is done. 
If installation is not proper check msi logs in the temp folder.
pause

Nota:  When using Windows authentication for connecting to Microsoft SQL Server database, ensure
that the following settings are configured:
• The IS_SQLSERVER_AUTHENTICATION installation parameter should be set to 0
• The user assigned to the $service_username parameter should be an active user in Microsoft SQL

Server with permissions set as: db_datareader, db_datawriter, and db_ddladmin
• The $db_user and $db_pwd parameter values should be disabled or commented out

3. Save the script you edit to the server for installation.
4. On the installation server, log on as an administrator, open Powershell in admin mode, and execute the

following: Set-ExecutionPolicy Unrestricted -Scope CurrentUser -Force
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5. Start Powershell in admin mode and execute: .\install.ps1

Nota:  I log di installazione invisibile vengono memorizzati nella cartella da cui viene eseguito lo script
di installazione. For example, if you run the script from C:\Silent Install, the logs are stored in
C:\Silent Install folder.

Complete the Control Room configuration and validation.
• After installing the Control Room, complete the configuration settings to ensure timely Automation

Anywhere communications are specified and confirm Automation Anywhere services are running.
• After completing the post-installation tasks, validate the setup by logging in to the Control Room and

installing a license. First time access to the Control Room walks you through the configuration for your
authentication method.

• In qualità di utente Cloud con autorizzazioni di amministratore, puoi creare, visualizzare, modificare,
eliminare, abilitare o disabilitare un utente. La creazione dei passaggi per gli utenti varia a seconda che
l'utente sia un utente non Active Directory, Active Directory o Single Sign On da un server IdP.

Concetti correlati
Post-installation user management alla pagina 979
After completing the post-installation tasks, validate the setup by logging in to the Control Room and
installing a license. First time access to the Control Room walks you through the configuration for your
authentication method.
Attività correlate
Complete Control Room post-installation configuration alla pagina 965
After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.
Performing silent installation of Control Room on Linux alla pagina 952
Silent Control Room installation, also known as unattended installation, uses a customized script with
parameters specific to your business requirements. The entire installation process runs in the background
without requiring user interaction or displaying messages.
Riferimenti correlati
Utenti alla pagina 2683
As an administrator, you can create, view, edit, delete, and enable or disable a user. Creating users steps
vary depending on whether the user is a non-Active Directory, Active Directory, or single sign-on (SSO)
user from an IdP server.

Complete Control Room post-installation configuration
After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.
1. Configure post-installation settings

After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.

2. Verify Automation Anywhere services

I servizi specifici Automation Anywhere sono installati sul server Control Room.
3. Configure Control Room for HTTPS certificate alla pagina 969

Configure Control Room for HTTPS mode using a self-signed or CA certificate either before or after
performing a custom Control Room configuration.
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4. Import HTTPS,and CA certificates alla pagina 970
After installing the Control Room, import a certificate for HTTPS, Certificate Authority (CA), or both
using the Windows or Linux command prompt.

5. Configure disaster recovery site for Elasticsearch IP addresses alla pagina 972
If you have configured the Control Room for high availability (HA) and disaster recovery (DR) and
installed the Control Room on both the primary and secondary sites, configure Elasticsearch IP
addresses for the secondary site.

6. Aggiungere l'indirizzo IP primario per il cluster alla pagina 972
If your Control Room server has dual IP addresses or network interface cards (NICs) and
you configure the second NIC as your backup IP address, you must manually update the
cluster.properties file to include the backup IP address.

7. Configurare l'indirizzo IP aggiuntivo per un nuovo nodo del cluster alla pagina 973
After installing the Control Room in the cluster node, when you add new nodes in the cluster, you
must configure additional static IP addresses for all the nodes in the property file on each node in the
cluster.

Configuring post-installation settings
After you finish installing the Control Room, configure specific items to ensure timely Automation Anywhere
communications.

Post-installation tasks and settings

Exclude anti-virus Exclude anti-virus scans from running in the
Automation Anywhere local repository because they
interfere with running bots.
By default, the repository path is C:
\ProgramData\AutomationAnywhere\Server
 Files. If you have modified the repository path
after installation, you can verify the path from
Administration > Settings > Control Room
database & software.

Set the language locale Select your language as the region setting.
The following example uses English (United States)
as the region setting.
• Windows: Select Control Panel > Region >

Administrative > Change system locale.
For usernames that contain non-ASCII
characters, update the following settings:
1. From Control Panel > Clock and Region

> Administrative > Change system
locale, select the required language from
the Current system locale list.

2. If available, clear the Beta: Use Unicode
UTF-8 for worldwide language support
check box.

3. To change the code page identifier, enter
chcp <identifier-code> at the
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command prompt. For example, enter chcp
 949 to use ANSI or OEM Korean (Unified
Hangul Code).
Code Page Identifiers

4. Riavvia il computer.

• Linux
1. Verify the current locale:

$ locale

2. Display a list of all available locales on the
server:
$ locale -a

3. Depending on your operating system, use
one of these options to set the locale for the
whole server with the LANG variable.
Substitute language en_US.UTF-8 with
your own:
Ubuntu: sudo update-locale
 LANG=en_US.UTF-8 LANGUAGE

Red Hat Enterprise Linux: sudo
 localectl set-locale
 LANG=en_US.UTF-8

4. Update either the global locale settings
file etc/locale.conf or settings /
~/.bash_profile for the user that owns
Automation 360:
LANG="en_US.utf8"

export LANG

Set the region Select your language as the region format.
Windows: Select Control Panel > Region >
Format.

Set time synchronization Enable Network Time Protocol (NTP) on the Control
Room.
For additional information about setting the NTP,
contact your system administrator.

For Microsoft Azure platform installation, set
configuration

Use the Microsoft Azure Portal to configure:
• Windows credentials
• Control Room settings for repository, URL, and

master key for Credential Vault
• Microsoft Active Directory authentication
• Optionally, SMTP settings
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Attività correlate
Complete Control Room post-installation configuration alla pagina 965
After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.
Riferimenti correlati
Verifying Automation Anywhere services alla pagina 968
Automation Anywhere specific services are installed on the Control Room server.
Working with SQL Servers alla pagina 848
Configure Microsoft SQL Servers before setting up the Control Room database.

Verifying Automation Anywhere services
Automation Anywhere specific services are installed on the Control Room server.

Linux users:  Consulta Stop and start Control Room services on Linux alla pagina 2795.

Verify installed Windows services

From your Windows device:
1. Seleziona Pannello di controllo > Strumenti di amministrazione > Servizi.

Il percorso specifico ai Servizi può variare a seconda della versione specifica di Windows.
2. Scroll through the list to find the listed service name. Notare che lo Stato deve essere visualizzato

come in esecuzione.

Control Room installed services
Verify that the following Windows services are installed by the Automation Anywhere Control Room
installer.

Nome servizio Descrizione

Automation Anywhere Bot Compiler
Service

Stores all details about the bot compile service. Receives and
processes Bot compilation requests for the Control Room.

Automation Anywhere Control
Room Caching Used for distributed cache storage.

Automation Anywhere Control
Room IQ Bot Service Used for Automation 360 IQ Bot.

Automation Anywhere Control
Room Messaging

Allows Control Room services to communicate
asynchronously.

Automation Anywhere Control
Room Reverse Proxy

Receives all incoming HTTP and HTTPS requests for
Automation Anywhere products and forwards to the correct
service.

Automation Anywhere Control
Room Robotic Interface Service

Is the Automation Anywhere Robotic Interface (AARI) service
used to create and orchestrate workflows between forms and
bots.

Automation Anywhere Control
Room Service Receives and processes API requests for the Control Room.
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Nome servizio Descrizione

Automation Anywhere Elastic
Search Service

Stores all logs and related activities for search functionality.
Per ulteriori informazioni su Elasticsearch, consulta Elastic
Stack e Documentazione del prodotto.

Automation Anywhere Control
Room Discovery Bot Service Used for Discovery Bot.

Automation Anywhere Control
Room Discovery Bot ML Service Utilizzato per il lancio di Discovery Bot da Control Room.

Automation Anywhere Control
Room Storage Service

Utilizzato come soluzione di archiviazione per sfruttare i
progetti di automazione.

• All the services can be configured either in the Local System or Domain account when the Control Room
is installed in Custom mode. Per Control Room installato in Modalità Express, tutti i servizi vengono
eseguiti nell'account di sistema locale.

• By default, the Automation Anywhere Control Room services restart automatically after a system
reboot. You do not need a windows service start-up script to restart the services.

• We recommend you wait for two (2) minutes for the Automation Anywhere Control Room services to
restart after a system reboot. If the services do not start automatically, you will see the Bad gateway
error. You can restart the services manually in any sequence.

• Running RPA Workspace services is mandatory for using the RPA Workspace platform. However,
running the AARI, Discovery Bot, and IQ Bot services is optional for RPA Workspace platform.

Concetti correlati
Installing Control Room using Custom mode alla pagina 902
Accedi al server come amministratore e installa Automation Anywhere Control Room in modalità
Personalizzazione per selezionare le opzioni di installazione e configurazione, inclusa l'installazione di
requisiti non predefiniti. Select this mode for a data center deployment.
Attività correlate
Installing Control Room using Express mode alla pagina 923
Installing Control Room on Linux alla pagina 948
You start installing the Automation Anywhere Control Room in the Linux environment and complete the
installation in the Control Room.

Configure Control Room for HTTPS certificate
Configure Control Room for HTTPS mode using a self-signed or CA certificate either before or after
performing a custom Control Room configuration.

Transportation Layer Security is configured as part of the Control Room installation. If that step was
skipped or the certificate expires, configure the TLS certificate with this post-installation configuration.

Importante:  It is not recommended to use self-signed certificates. However, if you use a self-signed
certificate, ensure you install the certificate on each device manually and accept the certificate to enable
communication between the device and the Control Room after configuring the self-signed certificate.

1. Accedi a Control Room.
The Control Room instance launches in your default browser.

2. Change the Control Room URL setting and port to HTTPS and port number to 443.
The Website Security Warning page is displayed.
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3. Continue to the Control Room website to access the Control Room.

Configure Control Room authentication options alla pagina 980
If you have already configured it, then log in to the Control Room.
Attività correlate
Import HTTPS,and CA certificates alla pagina 970
After you install the Control Room for an On-Premises deployments, you can use the Windows or Linux
command prompt to import all or some of these certificate:
Configure application Transport Layer Security alla pagina 907
Use the Transport Layer Security (TLS) configuration wizard page from the Automation 360 installer
to generate a self-signed certificate or import a security certificate to set up a highly secure Control Room
instance.

Import HTTPS,and CA certificates
After you install the Control Room for an On-Premises deployments, you can use the Windows or Linux
command prompt to import all or some of these certificate:
• HTTPS
• Certificate Authority (CA)

You can import HTTPS,and CA certificates in the following scenarios:
• Quando Control Room passa da HTTP a HTTPS dopo l'installazione di Automation 360.
• I certificati scadono o necessitano di modifiche, ad esempio quando si aggiunge un nuovo server.

These instructions apply to both Windows and Linux installations.
To import an HTTPS,or CA certificate to configure the Control Room for secure connection using the
command prompt, perform the following steps:
1. Run the command prompt in administrator mode.
2. Accedi al percorso di installazione di Automation Anywhere.

Il percorso di installazione predefinito per Windows è C:\Program Files\Automation Anywhere
\Automation360.
Il percorso di installazione predefinito per Linux è /opt/automationanywhere/enterprise
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3. Enter or paste the following at the command prompt:
• For Windows, if only server certificate is required or if the intermediate certificates are required and

all certificates are in a single file (single file with certificate chain), then enter the command:

jdk11\bin\java -jar certmgr.jar -appDir "C:\Program Files\Automation
 Anywhere\Automation360" -setServerCert "C:\Users\cradmin\Desktop
\test_automationanywhere_com.pfx" -privateKeyPass <PFX Password>

• For Windows CA certificate, enter the command:

jdk11\bin\java -jar certmgr.jar -appDir "C:\Program Files\Automation
 Anywhere\Automation360" -importTrustCert "D:\<user name>\My Downloads
\CA31.cer"

• For Linux CentOS HTTPS certificate, enter the command:

jdk11/bin/java -jar certmgr.jar -appDir "/opt/
automationanywhere/enterprise" -setServerCert "/home/<user>/
test_automationanywhere_com.pfx" -privateKeyPass <PFX Password>

• For Linux CentOS CA certificate, enter the command:

jdk11/bin/java -jar certmgr.jar -appDir 
                        "/opt/automationanywhere/enterprise" 
                        -importTrustCert "CA31.cer"

4. Restart the Control Room Reverse Proxy Service to view the imported certificates.
5. Durante l'installazione, se non hai accettato l'impostazione predefinita e hai indicato di voler caricare il

tuo certificato (autofirmato), aggiungi i seguenti parametri al file boot.db.properties che si trova
nella cartella config, nel percorso di installazione di Automation Anywhere.
• Windows file location:

root:\Program Files\Automation Anywhere\config\boot.db.properties
• Linux file location:

/opt/automationanywhere/enterprise/config/boot.db.properties

Parameter:

trustServerCertificate=false

Editing SQL user information
Edit MS-SQL configuration related settings, including username, password, database server name,
database server IP and port numbers.
To perform the task, you must have a  administrator account with the required rights and permissions.
Download the latest Control Room utility and make certain this utility installed on every sever where
Automation 360 is running.

Nota:

Users are required to make changes to the running configuration via the command line interface.
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Nota:  Please stop all Automation 360 services on all nodes where a Control Room is installed before
performing this task.

1. Open the command line prompt and navigate to the Automation 360 application.
For example, C:\Program Files\Automation Anywhere\jdk11\bin.

2. Follow the prompts from the utility to select the SQL database and enter the required credentials.

Nota:  The password will not be displayed on the console

3. Restart the Automation 360 services on the nodes.
The SQL user information has been successfully updated.

Configure disaster recovery site for Elasticsearch IP addresses
If you have configured the Control Room for high availability (HA) and disaster recovery (DR) and installed
the Control Room on both the primary and secondary sites, configure Elasticsearch IP addresses for the
secondary site.
Ensure that you are logged in to the  as the administrator.
Complete the Control Room installation on both the primary and secondary DR sites.
Before adding a new node, ensure the existing cluster is in yellow or green state and all ports on the new
node are open.
Perform this task to make the IP address of the secondary DR site Elasticsearch available to the primary
DR site.
1. From the primary site Control Room, navigate to Administration > Settings > General > Control

Room Database & Software.
2. Fai clic su Modifica.
3. Enter the DR secondary site Cluster IP address in the Elasticsearch disaster recovery backup

cluster field.
4. Click the plus sign to add additional cluster IP addresses.
5. Click Save Changes.

Concetti correlati
High availability deployment alla pagina 891
To support Automation 360 in your data center, configure an high availability (HA) cluster. Follow your
company methods and procedures for implementing your data center cluster.
Attività correlate
Warm stand-by alla pagina 896
Host two setups or sites - primary and backup for the warm stand-by DR procedure.

Aggiungere l'indirizzo IP primario per il cluster
Se il server Control Room dispone di più indirizzi IP o schede di interfaccia di rete (NIC), è possibile
aggiornare manualmente il file cluster.properties per includere l'indirizzo IP primario.
To perform the task, you must have a  administrator account with the required rights and permissions.
• Assicurati di disporre dell'autorizzazione per la visualizzazione e la gestione delle impostazioni.
• Completa l'installazione della Control Room.
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• L'aggiornamento del file cluster.properties richiede un tempo di inattività, quindi assicurati di
disporre di una finestra di manutenzione per quanto segue:
• Tutti i dispositivi utente verranno disconnessi.
• Durante la manutenzione non verranno eseguite pianificazioni.
• Bot Agent e Automation Anywhere Control Room non saranno accessibili.

Aggiorna il file cluster.properties per assicurati che il requisito del servizio di memorizzazione nella
cache definisca un singolo indirizzo IP per la NIC principale della Control Room.
Ensure that you complete these tasks on all the Control Room nodes in a high availability cluster.
1. Individua il file cluster.properties nella tua directory Control Room.

Ad esempio, la posizione predefinita è: C:\Program Files\Automation Anywhere
\Enterprise\config\

Se il file non esiste nella directory Control Room, crealo.
2. Add the following property option to the cluster.properties file:

ignite.local.static.ip=<nic_ip_address>
For example, ignite.local.static.ip=172.16.20.168

Nota:  The ignite.local.static.ip property is configured with a single IP address of the
primary NIC of the Control Room with which the communication between the Control Room nodes is
expected. È possibile riconfigurare manualmente la proprietà quando sono disponibili più indirizzi IP.

3. Salva il file cluster.properties.
4. Riavvia i seguenti servizi Windows Automation Anywhere:

a) Automation Anywhere Control Room Caching
b) Automation Anywhere Control Room Messaging
c) Automation Anywhere Control Room Service

5. Per essere sicuro che tutta la cache sia sincronizzata, riavvia il resto dei servizi Windows Automation
Anywhere.

Configurare l'indirizzo IP aggiuntivo per un nuovo nodo del cluster
Dopo aver installato la Control Room nel nodo del cluster, se si aggiungono nuovi nodi nel cluster, è
necessario configurare ulteriori indirizzi IP statici per tutti i nodi nel file delle proprietà per ciascun nodo del
cluster.
To perform the task, you must have a  administrator account with the required rights and permissions.
• Assicurati di disporre di una finestra di manutenzione che richieda tempi di inattività completa per i

seguenti componenti:
• Tutti i dispositivi utente verranno disconnessi.
• Durante la manutenzione non verranno eseguite pianificazioni.
• Bot Agent e Automation Anywhere Control Room non saranno accessibili.

• Completa l'installazione della Control Room su un qualsiasi nuovo nodo.

Esegui le seguenti operazioni su ciascun nodo del cluster:
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1. Arresta i seguenti servizi Automation Anywhere sul nodo della Control Room:
a) Automation Anywhere Control Room Reverse Proxy
b) Automation Anywhere Control Room Caching
c) Automation Anywhere Control Room Service
d) Automation Anywhere Elastic Search Service
e) Automation Anywhere Bot Insight Elastic Search
f) Automation Anywhere Control Room IQ Bot Service
g) Automation Anywhere Control Room Robotic Interface Service
h) Automation Anywhere Control Room Discovery Bot Service

2. Individua il file cluster.properties nella tua directory Control Room.
Ad esempio, la posizione predefinita è: C:\Program Files\Automation Anywhere
\Enterprise\config\

Se il file non esiste nella directory Control Room, crealo.
3. Aggiungi le seguenti proprietà e configura gli indirizzi IP primari come indirizzo IP statico per tutti i

nodi del cluster (inclusi i nodi del cluster esistenti) nel file cluster.properties.

ignite.discovery.mode=static
ignite.discovery.static.ips=<primary ip addresses>

For example: ignite.discovery.static.ips=10.0.11.153,10.0.11.13
4. Se i nodi hanno più indirizzi IP, aggiungi anche la seguente proprietà e configura un indirizzo IP

primario specifico per ciascun nodo del cluster:

ignite.local.static.ip=<primary ip address>

For example: ignite.local.static.ip=10.0.11.153
5. Salva il file cluster.properties.
6. Modifica il file elasticsearch.yml per il nuovo indirizzo IP:

a) Individua il file elasticsearch.yml nella directory Control Room.
Ad esempio, la posizione predefinita è: C:\Program Files\Automation Anywhere
\Enterprise\elasticsearch\config\elasticsearch.yml

b) Update elastcissearch.yml with the new IP address using the following property:
discovery.zen.ping.unicast.hosts:["ip1",”ip2”,”ip-new”]

c) Salva il file elasticsearch.yml.

7. Avvia tutti i servizi arrestati nella Fase 1 su ciascun nodo della Control Room.

Nota:  Attendi un intervallo di 40 secondi prima di iniziare il successivo intervento di manutenzione.

Add Automation 360 On-Premises URLs to trusted list
To ensure secure access to Automation 360 online services for On-Premises deployment, add the URL
specific to the service to the safe recipients or trusted list.
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Automation 360 On-Premises URLs list

L'hosting di servizi online Automation 360 utilizza indirizzi IP dinamici, pertanto si consiglia di aggiungere
ai destinatari sicuri o all'elenco attendibile il URL completo anziché un indirizzo IP per i servizi online
Automation Anywhere.

Nota:  L'elenco può variare in base all'ambiente dell'utente finale per le distribuzioni On-Premises.

Servizio URL Porta Dispositivi

Automation Anywhere www.automationanywhere.comTCP 443 (HTTPS) Tutti i dispositivi

Automation Anywhere
community (A-People)

apeople.automationanywhere.comTCP 443 (HTTPS) Tutti i dispositivi

Automation Anywhere
documentation

docs.automationanywhere.comTCP 443 (HTTPS) Tutti i dispositivi

Automation Anywhere Cloud
license server

license.automationanywhere.digitalTCP 443 (HTTPS) All devices that
run Automation
360 Control Room

Bot Store botstore.automationanywhere.comTCP 443 (HTTPS) Tutti i dispositivi

Telemetry
Consente di raccogliere
informazioni su prestazioni
e utilizzo in forma anonima
con l'intento di migliorare la
qualità del prodotto.

• cdn.pendo.io
• app.pendo.io/
• data.pendo.io/
• https://pendo-

static-5673999629942784.storage.googleapis.com/

TCP 443 (HTTPS) Tutti i dispositivi

Estensione Automation
Anywhere Google Chrome
Consente di automatizzare
l'utilizzo del browser Google
Chrome.

https://
chrome.google.com/
webstore/detail/
automation-360/
kammdlphdfejlopponbapgpbgakimokm

TCP 443 (HTTPS) Dispositivi Bot
Creator e Bot
Runner

Estensione Automation
Anywhere Microsoft Edge
Consente di automatizzare
l'utilizzo del browser
Microsoft Edge.

https://
microsoftedge.microsoft.com/
addons/detail/
automation-360/
dbmodiepejcigljbmeebedkmegndokbk

TCP 443 (HTTPS) Dispositivi Bot
Creator e Bot
Runner

Estensione Automation
Anywhere Mozilla Firefox
Consente di automatizzare
l'utilizzo del browser Mozilla
Firefox.

https://
addons.mozilla.org/
en-US/firefox/addon/
automation-360

TCP 443 (HTTPS) Dispositivi Bot
Creator e Bot
Runner
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File e cartelle

For information on files and folders to add to the safe list and to the antivirus exception list, see these
articles:
• Files and URLs to add to safe list for Automation 360 (A-People login required)
• List of files to add to antivirus exception list for Automation 360 (A-People login required)

Riferimenti correlati
Add Automation 360 Cloud URLs to trusted list alla pagina 831
To ensure secure access to Automation 360 cloud services, add the URL specific to the service to the safe
recipients or trusted list.

Disinstallazione di Automation 360
Use the Automation 360 installer or the Uninstall or change a program option from the Windows
Control Panel to remove or uninstall a Control Room instance.
1. Per disinstallare Control Room utilizzando il programma di installazione, esegui il file di installazione dal

percorso di installazione.
Run the installer in admin mode.

2. Nella procedura guidata InstallShield fai clic su Avanti.
3. Fai clic su Rimuovi.
4. Fai clic su Termina per completare la disinstallazione di Control Room dal computer o dal server.

Concetti correlati
Migrazione a Automation 360 alla pagina 1126
Riferimenti correlati
Installing Control Room On-Premises alla pagina 838
Review the installation core tasks and topics for installing the Automation 360 Control Room in a data
center on an On-Premises server or a cloud service provider server instance.

Installing Control Room for Cloud-enabled deployment
With Cloud-enabled deployment, you can store and process native business and operational data on site
and take advantage of management and operational services delivered from Automation Anywhere Cloud.
Automation Anywhere deploys and provisions an Automation 360 Cloud-enabled service instance in our
cloud to deliver management and operational capabilities. Customer then installs the Cloud-enabled
application within their infrastructure to consume these capabilities for storing and processing customer
data.

Nota:  Linux is not supported for Cloud-enabled deployments.

For Cloud-enabled deployment, the initial welcome email that you received from Automation Anywhere
contains:
• URL to the Automation Anywhere Cloud-enabled instance
• Provisioning token needed to establish trust connectivity with the Automation Anywhere Cloud Control

Room
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Importante:  Do not discard the content of this email. You will need the information in the email to setup
on-premises application.

1. Receive your Automation 360 Cloud-enabled service URL from Automation Anywhere and provisioning
token.

2. Install and access the On-Premises application.
Download and install the Cloud-enabled application on your network; the installation user is assigned
administrator privileges.
Installing Control Room On-Premises alla pagina 838

3. Log in to the On-Premises Control Room.
Accesso alla Automation Anywhere Control Room alla pagina 1022

4. Navigate to Administration > Settings > Cloud-Enabled.
5. Provide the provisioning token to connect to the Control Room.
6. Fai clic su Salva modifiche.

The trusted relationship between the instances is created.
7. To test Cloud-Enabled functionality, open a browser, enter the URL of the Cloud Control Room service

instance, and press Enter.
You are redirected to the On-Premises Control Room.

Concetti correlati
Post-installation user management alla pagina 979
After completing the post-installation tasks, validate the setup by logging in to the Control Room and
installing a license. First time access to the Control Room walks you through the configuration for your
authentication method.
Attività correlate
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039
Install Bot Agent on your local device and connect it to Control Room. In order to run bots on that local
device, ensure that you add it to the list of enabled host devices.
Riferimenti correlati
Installed Control Room directories and files alla pagina 1002
When installing the Automation Anywhere Control Room on different operating systems, the installer
executes and installs files and folders in the following directories.

Naming guidelines for Control Room URLs
Adhere to Domain Name System (DNS) guidelines when you configure domain and subdomain Control
Room URLs for On-Premises and Cloud deployments.
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Guidelines for On-Premises Control Room deployments

By following these DNS guidelines, you can successfully register your Bot Agent with the On-Premises
Control Room. According to RFC 952, RFC 1035, and RFC 1123, the following guidelines apply when
creating names for domain and subdomain URLs:
• The host name can be up to 63 characters in length and can contain the following characters:

• Uppercase characters (A–Z)
• Lowercase characters (a–z)
• Numerals (0–9)
• Hyphens (-)

• The host name should not consist of all numeric values.
• The host name should not start nor end with a hyphen (-).
• The URL domain and subdomain names should not contain the underscore character (_).

Nota:  Instead of an underscore (_), use a hyphen (-).

Guidelines for Cloud Control Room deployments

By following DNS guidelines, you can successfully register your Bot Agent with
the Cloud Control Room. The Cloud Control Room URL syntax is: https://
<domainname>.myautomationanywhere.digital, where <domainname> is configurable.
• The domain name can be up to 27 characters in length and can contain the following characters:

• Lowercase characters (a–z)
• Numerals (0–9)
• Hyphens (-)

• The domain name should not consist of all numeric values.
• The domain name should not start nor end with a hyphen (-).
• The URL domain and subdomain names should not contain the underscore character (_).

Nota:  Instead of an underscore (_), use a hyphen (-).

Riferimenti correlati
Automation 360 Cloud prerequisites alla pagina 828
Utilizza l'elenco di controllo per determinare se il dispositivo soddisfa i requisiti per la registrazione con
Automation 360 Cloud.
Automation 360 On-Premises prerequisites alla pagina 840
Determina se il sistema dispone dell'hardware e del software necessari per installare la Control Room per
Automation 360 On-Premises.

© 2023 Automation Anywhere. All rights reserved.     978



    Automation Anywhere - Installazione e aggiornamento Automation 360

Post-installation user management
After completing the post-installation tasks, validate the setup by logging in to the Control Room and
installing a license. First time access to the Control Room walks you through the configuration for your
authentication method.

Configure Control Room authentication options alla
pagina 980

Le opzioni per lanciare la Control Room per la prima
volta e il metodo di autenticazione dipendono dalla
modalità di installazione e dal tipo di distribuzione.

Validate services Validate that the following services are running in
automatic mode:
• Automation Anywhere Control Room Caching
• Automation Anywhere Control Room Messaging
• Automation Anywhere Control Room Reverse

Proxy
• Automation Anywhere Control Room Service
• Automation Anywhere Elastic Search Service
• Automation Anywhere Bot Compiler Service
• Automation Anywhere Control Room IQ Bot

Service
• Automation Anywhere Control Room Robotic

Interface Service
• Automation Anywhere Control Room Discovery

Bot Service
• Automation Anywhere Control Room Discovery

Bot ML Service
• Automation Anywhere Control Room Storage

Service

Utenti alla pagina 2683 As an administrator, you can create, view, edit,
delete, and enable or disable a user. La creazione
dei passaggi per gli utenti varia a seconda che
l'utente sia un utente non Active Directory, Active
Directory o Single Sign On da un server IdP.

Attività correlate
Complete Control Room post-installation configuration alla pagina 965
After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.

Configure the Control Room as a service provider
A valid SAML IDP setup must be configured before the Control Room can be switched to a SAML-
authentication environment.
This task is performed by a network administrator. You must have the necessary privileges to complete this
configuration.
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Complete the necessary network-side preparations to switch the Control Room to act as the service
provider in the SAML IDP setup.
1. Set the ACS or service provider URL to <Enterprise Control Room URL>/v1/

authentication/saml/assertion.

Nota:  Ensure that you do not configure the SAML assertions for single logout.

2. Create user with matching information in the Control Room.
Key attributes include: UserID, FirstName, LastName, and EmailAddress.
This value will be required when setting up the Control Room side of this configuration.

3.
4. Update SAML settings for Active Directory.

Make the necessary updates to pertinent directories and toolkits, making certain to select Single Sign
On as the login method.

<saml2:AuthnStatement
 AuthnInstant="authenticated_instance" SessionIndex="index_value_required">

Set up SAML authentication on the Control Room

Attività correlate
Configurazione dell'autenticazione SAML alla pagina 995
Switch an authenticated environment Control Room database to a SAML identity provider (IdP).

Configure Control Room authentication options
The options for launching the Control Room for the first time and the authentication method depend on
the installation mode and deployment type.
The authentication options for Control Room in Cloud and Cloud-enabled deployments differ from the
options for On-Premises deployment (installed using the Custom mode).
After the installation (Custom mode) is complete, configure the Control Room in Custom mode to
authenticate users with an Active Directory (AD), Control Room database, or single sign-on (SSO).

Nota:  The Active Directory authentication mode is available for On-Premises deployment and not for
Cloud and Cloud-enabled deployments.

Based on your installation mode (express or custom) and deployment type (On-Premises, Cloud, and
Cloud-enabled), select any of the following authentication methods for the Control Room:
• After an Express mode installation, configure the Control Room in Express mode using the default

settings.
Configure Control Room in Express mode alla pagina 981

• Authenticate users using Active Directory by manually adding the LDAP URLs.
Configure Control Room for Active Directory: manual mode alla pagina 982

• Authenticate users using Active Directory by enabling the Control Room to discover and list domains
and sites in your organization.
Configure Control Room for Active Directory: auto mode alla pagina 984

© 2023 Automation Anywhere. All rights reserved.     980



    Automation Anywhere - Installazione e aggiornamento Automation 360

• Authenticate users using the database option.
Configurazione del database della Control Room alla pagina 990

• Configure an authenticated environment Control Room database to a SAML identity provider (IDP).
Configurazione dell'autenticazione SAML alla pagina 995

• Configure the environment for Smart Card, X.509 Certificate authentication.
Configure Smart Card authentication installation procedure alla pagina 987

Configure Control Room in Express mode
After completing the installation in Express Mode, configure the Control Room in Express Mode using the
default settings.
To configure Control Room when you start it for the first time, do the following steps:
1. Open Control Room in a browser to launch the Getting Started wizard.

• Windows: Double-click the Automation Anywhere Control Room icon on the desktop.
• Linux: Open a browser and navigate to the Linux server hostname. Example:

server1.mycompany.com

2. Compila i seguenti campi:
• Nome utente: inserisci un nome utente.
• Nome: inserisci il nome.
• Cognome: inserisci il cognome.
• E-mail: inserisci un indirizzo e-mail.
• Password: inserisci una password.
• Conferma password: conferma la password.

3. Fai clic su Avanti.
Viene visualizzata la pagina Crea domande di sicurezza.

4. Inserisci tre domande e risposte di sicurezza.
5. Fai clic su Avanti.

The Credential settings page appears.
6. Scegli tra le seguenti opzioni:

• Express mode:The system stores your master key to connect to the Credential Vault on the
Control Room filesystem. Questa opzione non è consigliata per un ambiente di produzione.

• Modalità Manuale: puoi archiviare la Master Key autonomamente e fornirla quando il Credential
Vault è bloccato. Gli utenti utilizzano la Master Key per connettersi al Credential Vault per
proteggere le proprie credenziali e accedervi durante la creazione e l'esecuzione dei TaskBots.

Importante:  se perdi la chiave, non potrai accedere alla Control Room.

7. Fai clic su Salva e accedi.
Hai eseguito l'accesso alla Control Room come amministratore. Ora puoi configurare e gestire
l'ambiente RPA globale con la Control Room e i client.

After configuring the Control Room, install product licenses.
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Configure Control Room for Active Directory: manual mode
Configure the Control Room to authenticate users using Active Directory by manually adding the
Lightweight Directory Access Protocol (LDAP) URLs.
To configure the Control Room when you start it for the first time, do the following:
1. Double-click the Automation Anywhere Control Room icon on your desktop.

Viene visualizzata la pagina Configura impostazioni Control Room.
2. Type the repository path.

This is the location where the uploaded automation files, for example, IQ Bots, and TaskBots are
stored. For example, C:\ProgramData\AutomationAnywhere\Server Files.

3. Inserisci l'URL di accesso.
Si tratta dell'URL per accedere all'installazione della Control Room.

4. Fai clic su Salva e continua.

Importante:  il pulsante Indietro del browser Web viene automaticamente disattivato dopo aver
fatto clic su Salva e continua. Ciò garantisce che la Master Key del Credential Vault generata
corrisponda al percorso dell'archivio e all'URL di accesso alla Control Room.
Per tornare alla pagina Configura impostazioni Control Room, premi Ctrl + F5 e riavvia.

Viene visualizzata la pagina Impostazioni Credential Vault.
5. Scegli tra le seguenti opzioni:

• Modalità Express: il sistema memorizza la chiave master per connettersi al Credential Vault.
Questa opzione non è consigliata per un ambiente di produzione.

• Modalità Manuale: puoi archiviare la Master Key autonomamente e fornirla quando il Credential
Vault è bloccato. Gli utenti utilizzano la Master Key per connettersi al Credential Vault per
proteggere le proprie credenziali e accedervi durante la creazione e l'esecuzione dei TaskBots.

Importante:  se perdi la chiave, non potrai accedere alla Control Room.

6. Fai clic su Salva e continua.

Importante:  il pulsante Indietro del browser Web viene automaticamente disattivato dopo aver
fatto clic su Salva e continua. Non sono consentite ulteriori modifiche alla configurazione della
Control Room o alle impostazioni del Credential Vault.
Per apportare le modifiche, devi reinstallare la Control Room.

Viene visualizzata la pagina Tipo di autenticazione per gli utenti della Control Room.
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7. Select Active Directory.
Automation Anywhere supports Active Directory Multi-Forest authentication for the Control Room.
Before providing the Authentication Type, ensure the following:
• One-way or two-way trust is set up between all forests. For a one-way trust, this is from the

Enterprise Client forest to the Control Room forest (Control Room forest must always be the
trusting forest).

• Two-way trust is set up for every domain in a forest.
• The root certificate of the LDAP server is imported using the provided CertMgr tool via command.
• The provided LDAP URLs per forest cannot be behind a load balancer. Also, all LDAP URLs must

point to the root (main) domain controllers.
• The node that runs the Control Room is in the same domain network where the Active Directory

runs.
• The user is in the parent domain and the URL points to the parent.

This ensures that when there are two or more forests, and one of the forest has a subdomain with
a different name space, a user from the other forests does not have permission to access that
subdomain.

8. Type the Global Catalog URL.
Ad esempio, ldap://server01.domain.com.
For failsafe authentication, click the plus option to provide additional LDAP URLs.

Nota:  For users and groups from one or more Active Directory domains, to access the Control Room,
use a fully qualified host name of the Global Catalog (GC) server, listening on port 3268 (3269 if SSL).

When adding LDAP URLs, ensure that you provide a fully qualified host name like ldap://
server01.ldap.com.
Provide URLs of multiple Global Catalogs per forest so that if one Global Catalog in a forest goes
down, the other can serve. This feature does not provide support for the load-balanced URL.
You must enter the Domain username and password and click Manually add connections to enter
the LDAP URLs.

9. Provide service account credentials
Ensure that the username provided is a user in the Domain Users group and ideally and be set up in
Active Directory with a password never expires option. If otherwise, there will be some downtime
in RPA authentication as the service account password is reset. Provide the username in a User
Principal Name (UPN) in the username@domain.com format and password.

10. Click Check connection.
If Control Room is unable to connect to the Active Directory database, an error message appears.

11. Fai clic su Avanti.
Viene visualizzata la pagina Primo amministratore della Control Room.

12. Select the Active Directory domain from the drop-down list and type the Control Room
administrator username.

13. Click Check name in Active Directory.
If the username is in the Active Directory the following user details are shown:
• First name
• Last name
• E-mail

You can edit these prepopulated fields.
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14. Fai clic su Salva e accedi.
Hai eseguito l'accesso alla Control Room come amministratore. Ora puoi configurare e gestire
l'ambiente RPA globale con la Control Room e i client.

After configuring the Control Room, install product licenses.
Attività correlate
Configure Control Room for Active Directory: auto mode alla pagina 984
Configure the Control Room to authenticate users using Active Directory by enabling the Control Room to
discover and list domains and sites in your organization.

Configure LDAP channel binding
Configure LDAP channel binding in Automation 360 On-Premises for enhanced security in network
communications between an Active Directory and its clients. This method provides a more secure LDAP
authentication over SSL and TLS.
Enable channel binding in the um.properties file when required.
1. Go to the Control Room installation path.
2. From the list of files in the config folder, open the um.properties file with an XML editor.
3. Add the um.ldap.channel.binding.enabled property in the um.properties file.

For example, um.ldap.channel.binding.enabled=false
4. To enable channel binding, change the value to true.

The default value is false and channel binding is disabled.
Channel binding is enabled if it is enabled on the server side.
For information about enabling channel binding on the server side, see LDAP enforce channel binding
registry entry.

5. Salva il file.

Configure Control Room for Active Directory: auto mode
Configure the Control Room to authenticate users using Active Directory by enabling the Control Room to
discover and list domains and sites in your organization.
To configure the Control Room when you start it for the first time, do the following:
1. Double-click the Automation Anywhere Control Room icon on your desktop.

Viene visualizzata la pagina Configura impostazioni Control Room.
2. Type the repository path.

This is the location where the uploaded automation files, for example, IQ Bots, and TaskBots are
stored. For example, C:\ProgramData\AutomationAnywhere\Server Files.

3. Inserisci l'URL di accesso.
Si tratta dell'URL per accedere all'installazione della Control Room.

4. Fai clic su Salva e continua.

Importante:  il pulsante Indietro del browser Web viene automaticamente disattivato dopo aver
fatto clic su Salva e continua. Ciò garantisce che la Master Key del Credential Vault generata
corrisponda al percorso dell'archivio e all'URL di accesso alla Control Room.
Per tornare alla pagina Configura impostazioni Control Room, premi Ctrl + F5 e riavvia.

Viene visualizzata la pagina Impostazioni Credential Vault.
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5. Scegli tra le seguenti opzioni:
• Modalità Express: il sistema memorizza la chiave master per connettersi al Credential Vault.

Questa opzione non è consigliata per un ambiente di produzione.
• Modalità Manuale: puoi archiviare la Master Key autonomamente e fornirla quando il Credential

Vault è bloccato. Gli utenti utilizzano la Master Key per connettersi al Credential Vault per
proteggere le proprie credenziali e accedervi durante la creazione e l'esecuzione dei TaskBots.

Importante:  se perdi la chiave, non potrai accedere alla Control Room.

6. Fai clic su Salva e continua.

Importante:  il pulsante Indietro del browser Web viene automaticamente disattivato dopo aver
fatto clic su Salva e continua. Non sono consentite ulteriori modifiche alla configurazione della
Control Room o alle impostazioni del Credential Vault.
Per apportare le modifiche, devi reinstallare la Control Room.

Viene visualizzata la pagina Tipo di autenticazione per gli utenti della Control Room.
7. Select Active Directory.

Automation Anywhere supports Active Directory multi-forest authentication for the Control Room.
Before providing the authentication type, ensure the following:
• For one-way trust between forests:

• The Bot Agent devices are in one or more forests and the Control Room is in a different forest,
theControl Room must be in the trusting forest.

• Set up trust between the forest that contains the Control Room and each of the forests
containing the Bot Agent devices.

• Domains containing Bot Agent devices and the Control Room must be configured with two-way
trust between the domains.

• For two-way trust between forests:
• In the scenario where the Bot Agent devices are in one or more forests and the Control Room

is in a different forest, all forests containing Bot Agent device and the Control Room are
configured with two-way trust between forests.

• Set up trust between all forests containing the Control Room and the Bot Agent devices.
• Domains containing Bot Agent devices and the Control Room must be configured with two-way

trust between the domains.

• The root certificate of the LDAP server is imported using the provided CertMgr tool via command.
• The provided LDAP URLs per forest cannot be behind a load balancer. Also, all LDAP URLs must

point to the root (main) domain controllers.
• The node that runs the Control Room is in the same domain network where the Active Directory

runs.
• The user is in the parent domain and the URL points to the parent.

This ensures that when there are two or more forests, and one of the forest has a sub-domain with
a different name space, a user from the other forests does not have permission to access that sub-
domain.

8. Type the Domain username.
Ensure you use the User Principal Name (UPN) in the username@domain.com format.
The username you enter is for a user who has access to all domains using the same credentials.
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9. Type the Domain password.
This user is not expected to use the Control Room. Although you have an option to update the
password, use an Account with the password never expires option. If it expires, it can be updated but
with some downtime.

10. Click Discover connections.
All discovered Active Directory domains with one or more sites per domain are shown.
By default, all domains and sites are selected. If only one domain and one site under it is discovered,
then it is shown in read-only mode and cannot be edited.
You can configure the maximum number of sites per domain that can be discovered across multiple
domains by adding the following property in the um.properties file saved in <installation
 path>/config:
um.ldap.auto.discovery.find.max.sites=<number of sites>

For example, you can configure auto-discovery for a maximum of 15 sites per domain by adding the
entry um.ldap.auto.discovery.find.max.sites=15 in the um.properties file. This means
that for every domain that you have, a maximum of 15 associated sites can be discovered per domain.

Nota:  If this property is not configured, by default, 10 sites per domain will be discovered.

11. Select the domains and sites to use for authentication.
Select the domains and sites to use for authentication. Select a minimum of one site for each domain
that is selected

12. Click Test connections to register the sites to use for authentication.
13. Click Check connection.

If Control Room is unable to connect to the Active Directory database, an error message appears.
14. Fai clic su Avanti.

Viene visualizzata la pagina Primo amministratore della Control Room.
15. Select the Active Directory domain from the drop-down list and type the Control Room

administrator username.
16. Click Check name in Active Directory.

If the username is in the Active Directory the following user details are shown:
• First name
• Last name
• E-mail

You can edit these pre-populated fields.
17. Fai clic su Salva e accedi.

Hai eseguito l'accesso alla Control Room come amministratore. You can now configure and manage
the overall RPA environment with Control Room and Bot Agent.

After configuring the Control Room, install product licenses.
Attività correlate
Configure Control Room for Active Directory: manual mode alla pagina 982
Configure the Control Room to authenticate users using Active Directory by manually adding the
Lightweight Directory Access Protocol (LDAP) URLs.
Configurazione del database della Control Room alla pagina 990
Configura la Control Room per eseguire l'autenticazione gli utenti utilizzando l'opzione di database.
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Configure Smart Card authentication installation procedure
Configure the Control Room to authenticate users using the Smart Card option.
To perform the task, you must have a  administrator account with the required rights and permissions.
Follow these steps to configure your Cloud Control Room to use Smart Card, X.509 certificate
authentication.
1. Configure the secondary hostname to point to the Control Room load balancer.

This process defines the secondary hostname used for authentication requests when the Control Room
is configured for Smart Card authentication. The secondary hostname is configured within the Control
Room load balancer automatically. Both the primary and secondary hostnames must be configured
within the DNS system used by the Control Room environment (add DNS entries for primary and
secondary hostnames - external to Control Room).

2. How to obtain Java KeyStore with trusted CA certificates.
Configure the location the Control Room will check for Certificate Authority (CA) certificates used to
authenticate user certificates for user logins.

Nota:  The certificates in this location are the server certificates for the CAs that will issue the user
certificates.

Opzione Azione

Esegui periodicamente la scansione della
seguente posizione

This setting allows the administrator to define
the path to keystore file containing the CA
certificates. Use this setting if you periodically
update the CA truststore and set the frequency of
the scan.

Carica la KeyStore manualmente This setting allows the administrator to load a
keystore file containing the CA certificates. Use
this setting if your CAs are known and static and
indicate whether or not the keystore is password
protected. If the keystore is password protected,
supply and confirm the password.

3. Select the revocation checking method.
Revocation checking configures the Control Room to reject authentication requests for certificates that
have been revoked.
Opzione Azione

Online Certificate Status Protocol (OSCP) Use this setting if your CA has OSCP
implemented.

Elenco revoche certificati Use this setting if you maintain a static list of
revoked certificates.

Nessuna verifica revoca Using this setting the Control Room will not
perform revocation check.

Nota:  This is not recommended for production
deployments where revocation will typically be
used.
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4. Use the other method if selected method fails
This setting will attempt to use the non-selected method of revocation checking if the configured
method fails.

5. Allow user to authenticate even if revocation status cannot be determined
Use this setting to assure users can authenticate if either of the revocation check method fails.

6. Configure user name mapping.
User name mapping specifies which attribute of the user certificate is used for the Control Room
username. The user name must be configured in the Control Room prior to the user logging into the
Control Room and must match the user name derived from the certificate.
a) Obtain user name from

Oggetto del certificato Use this setting if the Control Room user name
is the same as the string in the Subject field for
the user certificate.

Nome responsabile universale Use this setting if the Control Room user name
is the same as the string in the Universal
Principal Name field for the user certificate.

b) Use Regular Expression
Enter Regular Expression that will filter the Control Room user name from the selected field of the
user certificate. This may not be necessary if the Control Room user name is the same as the data
within the selected certificate field.

7. Configure first name mapping.
First name mapping specifies which attribute of the user certificate is used for the Control Room
username. The first name must be configured in the Control Room prior to the user logging into the
Control Room and must match the user first name derived from the certificate.
a) Obtain first name from

Oggetto del certificato Use this setting if the Control Room first name
is the same as the string in the Subject field for
the user certificate.

Nome responsabile universale Use this setting if the Control Room user name
is the same as the string in the Universal
Principal Name field for the user certificate.

b) Use Regular Expression
Enter Regular Expression that will filter the Control Room user first name from the selected field
of the user certificate. This may not be necessary if the Control Room user first name is the same
as the data within the selected certificate field.

8. Configure last name mapping.
Last name mapping specifies which attribute of the user certificate is used for the Control Room
username. The last name must be configured in the Control Room prior to the user logging into the
Control Room and must match the user last name derived from the certificate.
a) Obtain last name from

Oggetto del certificato Use this setting if the Control Room last name
is the same as the string in the Subject field for
the user certificate.
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Nome responsabile universale Use this setting if the Control Room user name
is the same as the string in the Universal
Principal Name field for the user certificate.

b) Use Regular Expression
Enter Regular Expression that will filter the Control Room user last name from the selected field of
the user certificate. This may not be necessary if the Control Room user last name is the same as
the data within the selected certificate field.

9. Configure email address mapping.
Email address mapping specifies which attribute of the user certificate is used for the Control Room
username. The email address must be configured in the Control Room prior to the user logging into
the Control Room and must match the user last name derived from the certificate.
a) Obtain last name from

Oggetto del certificato Use this setting if the Control Room email
address is the same as the string in the Subject
field for the user certificate.

Nome responsabile universale Use this setting if the Control Room user name
is the same as the string in the Universal
Principal Name field for the user certificate.

b) Use Regular Expression
Enter Regular Expression that will filter the Control Room user email address from the selected
field of the user certificate. This may not be necessary if the Control Room user email address is
the same as the data within the selected certificate field.

10. Fai clic su Avanti.

Control Room smart card first administrator
After configuring the smart card authentication process, an administrator user is needed. This process will
walk you through setting up the first administrator for the Control Room.
To perform the task, you must have a  administrator account with the required rights and permissions.
When authenticating with smart cards, the authenticating system will send a signal to the operating
system to "Insert Smart Card" and prompt the user, from the smart card software, to select the certificate
to use for authentication.
The following steps guide you through setting up your first administrator user with smart card
authentication installed.
You should be on the correct configuration page if you have completed Configure Smart Card authentication
installation procedure alla pagina 987.
1. Navigate to  > Control Room first administrator.
2. Insert the smart card for the administrator.
3. Click Authenticate and pre-fill user data.

This will start the smart card authentication process and pre-fill data from the selected certificate
base on the mappings defined during the configuration of the Certificate (smart card) authentication
installation process. If any information requires correction, click the Back button and make the
necessary changes.

4. Verify the data.
View the Username, First Name, Last Name, and Email Address that is pre-filled and verify that these
data points were correctly mapped during the smart card authentication installation procedure.
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5. Click Save and log in
The configuration of Certificate (smart card) authentication strategy is complete.

After configuration of the smart card authentication process, the login page of the Control Room will
display only the "Insert CAC/PIV" option for authenticating the user. Pressing this button will start the
smart card authentication process and the browser will signal a smart card login request to the operating
system which will then prompt the user to insert their smart card and possibly an optional PIN.
The user selects the appropriate certificate on the smart card and proceeds with the Control Room login.

Configurazione del database della Control Room
Configura la Control Room per eseguire l'autenticazione gli utenti utilizzando l'opzione di database.
To configure the Control Room when you start it for the first time, do the following:
1. Apri un browser e accedi all'URL della Control Room.

Viene visualizzata la pagina Configura impostazioni Control Room.
• Windows

Fai doppio clic sull'icona Automation Anywhere Control Room sul desktop.
• Linux

Apri un browser e vai al nome host del server su cui è stata installata la Automation Anywhere
Control Room. Esempio: myserver.mycompany.com

Nota:  non lasciare la barra alla fine dell'URL, poiché ciò impedirà la convalida.

2. Inserisci il percorso dell'archivio.
• Windows

La posizione in cui vengono archiviati i file per l'automazione caricati, come IQ Bot e TaskBots. Ad
esempio,
C:\ProgramData\AutomationAnywhere\Server Files

• Linux
/opt/automationanywhere/enterprise/appdata

3. Inserisci l'URL di accesso.
Si tratta dell'URL per accedere all'installazione della Control Room.

4. Fai clic su Salva e continua.

Importante:  il pulsante Indietro del browser Web viene automaticamente disattivato dopo aver
fatto clic su Salva e continua. Ciò garantisce che la Master Key del Credential Vault generata
corrisponda al percorso dell'archivio e all'URL di accesso alla Control Room.
Per tornare alla pagina Configura impostazioni Control Room, premi Ctrl + F5 e riavvia.

Viene visualizzata la pagina Impostazioni Credential Vault.
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5. Scegli tra le seguenti opzioni:
• Modalità Express: il sistema memorizza la chiave master per connettersi al Credential Vault.

Questa opzione non è consigliata per un ambiente di produzione.
• Modalità Manuale: puoi archiviare la Master Key autonomamente e fornirla quando il Credential

Vault è bloccato. Gli utenti utilizzano la Master Key per connettersi al Credential Vault per
proteggere le proprie credenziali e accedervi durante la creazione e l'esecuzione dei TaskBots.

Importante:  se perdi la chiave, non potrai accedere alla Control Room.

6. Fai clic su Salva e continua.

Importante:  il pulsante Indietro del browser Web viene automaticamente disattivato dopo aver
fatto clic su Salva e continua. Non sono consentite ulteriori modifiche alla configurazione della
Control Room o alle impostazioni del Credential Vault.
Per apportare le modifiche, devi reinstallare la Control Room.

Viene visualizzata la pagina Tipo di autenticazione per gli utenti della Control Room.
7. Seleziona Database Control Room.

Seleziona Active Directory, Single Sign-On (SAML 2.), Certificato (Smart card) o Database Control
Room. Per i passaggi e i processi specifici, consulta gli argomenti relativi alla configurazione.

8. Fai clic su Avanti.
Viene visualizzata la pagina Primo amministratore della Control Room.

9. Compila i seguenti campi:
• Nome utente: inserisci un nome utente.
• Nome: inserisci il nome.
• Cognome: inserisci il cognome.
• E-mail: inserisci un indirizzo e-mail.
• Password: inserisci una password.
• Conferma password: conferma la password.

10. Fai clic su Avanti.
Viene visualizzata la pagina Crea domande di sicurezza.

11. Inserisci tre domande e risposte di sicurezza.
12. Fai clic su Salva e accedi.

Hai eseguito l'accesso alla Control Room come amministratore. Ora puoi configurare e gestire
l'ambiente RPA globale con la Control Room e i client.

Installa una licenza.
Attività correlate
Configure Control Room for Active Directory: manual mode alla pagina 982
Configure the Control Room to authenticate users using Active Directory by manually adding the
Lightweight Directory Access Protocol (LDAP) URLs.
Configure Control Room for Active Directory: auto mode alla pagina 984
Configure the Control Room to authenticate users using Active Directory by enabling the Control Room to
discover and list domains and sites in your organization.

Configure Control Room for HTTPS certificate
Configure Control Room for HTTPS mode using a self-signed or CA certificate either before or after
performing a custom Control Room configuration.
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Transportation Layer Security is configured as part of the Control Room installation. If that step was
skipped or the certificate expires, configure the TLS certificate with this post-installation configuration.

Importante:  It is not recommended to use self-signed certificates. However, if you use a self-signed
certificate, ensure you install the certificate on each device manually and accept the certificate to enable
communication between the device and the Control Room after configuring the self-signed certificate.

1. Accedi a Control Room.
The Control Room instance launches in your default browser.

2. Change the Control Room URL setting and port to HTTPS and port number to 443.
The Website Security Warning page is displayed.

3. Continue to the Control Room website to access the Control Room.

Configure Control Room authentication options alla pagina 980
If you have already configured it, then log in to the Control Room.
Attività correlate
Import HTTPS,and CA certificates alla pagina 970
After you install the Control Room for an On-Premises deployments, you can use the Windows or Linux
command prompt to import all or some of these certificate:
Configure application Transport Layer Security alla pagina 907
Use the Transport Layer Security (TLS) configuration wizard page from the Automation 360 installer
to generate a self-signed certificate or import a security certificate to set up a highly secure Control Room
instance.

Import HTTPS,and CA certificates
After you install the Control Room for an On-Premises deployments, you can use the Windows or Linux
command prompt to import all or some of these certificate:
• HTTPS
• Certificate Authority (CA)

You can import HTTPS,and CA certificates in the following scenarios:
• Quando Control Room passa da HTTP a HTTPS dopo l'installazione di Automation 360.
• I certificati scadono o necessitano di modifiche, ad esempio quando si aggiunge un nuovo server.

These instructions apply to both Windows and Linux installations.
To import an HTTPS,or CA certificate to configure the Control Room for secure connection using the
command prompt, perform the following steps:
1. Run the command prompt in administrator mode.
2. Accedi al percorso di installazione di Automation Anywhere.

Il percorso di installazione predefinito per Windows è C:\Program Files\Automation Anywhere
\Automation360.
Il percorso di installazione predefinito per Linux è /opt/automationanywhere/enterprise

3. Enter or paste the following at the command prompt:
• For Windows, if only server certificate is required or if the intermediate certificates are required and

all certificates are in a single file (single file with certificate chain), then enter the command:

jdk11\bin\java -jar certmgr.jar -appDir "C:\Program Files\Automation
 Anywhere\Automation360" -setServerCert "C:\Users\cradmin\Desktop
\test_automationanywhere_com.pfx" -privateKeyPass <PFX Password>
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• For Windows CA certificate, enter the command:

jdk11\bin\java -jar certmgr.jar -appDir "C:\Program Files\Automation
 Anywhere\Automation360" -importTrustCert "D:\<user name>\My Downloads
\CA31.cer"

• For Linux CentOS HTTPS certificate, enter the command:

jdk11/bin/java -jar certmgr.jar -appDir "/opt/
automationanywhere/enterprise" -setServerCert "/home/<user>/
test_automationanywhere_com.pfx" -privateKeyPass <PFX Password>

• For Linux CentOS CA certificate, enter the command:

jdk11/bin/java -jar certmgr.jar -appDir 
                        "/opt/automationanywhere/enterprise" 
                        -importTrustCert "CA31.cer"

4. Restart the Control Room Reverse Proxy Service to view the imported certificates.
5. Durante l'installazione, se non hai accettato l'impostazione predefinita e hai indicato di voler caricare il

tuo certificato (autofirmato), aggiungi i seguenti parametri al file boot.db.properties che si trova
nella cartella config, nel percorso di installazione di Automation Anywhere.
• Windows file location:

root:\Program Files\Automation Anywhere\config\boot.db.properties
• Linux file location:

/opt/automationanywhere/enterprise/config/boot.db.properties

Parameter:

trustServerCertificate=false

Add Control Room certificate to Windows certificate stores
To ensure that the Bot Agent is registered successfully and works as intended, manually add or update
the Control Room certificate to the Windows certificate stores. Perform this task if the Windows certificate
stores does not accept the certificate and you see a certificate path validation error.
You must reinstall the certificates in the Windows certificate stores if the Bot Agent is updated.
Per risolvere il certificato nel browser del computer Bot Agent, scarica e installa il certificato autofirmato.
1. Per scaricare il certificato autofirmato utilizzando Google Chrome, procedi come segue:

a) Apri l'istanza Control Room utilizzata per accedere a Bot Agent.
b) Premi il tasto funzione F12 per aprire la finestra dello sviluppatore.
c) Navigate to the Security tab and click the View certificate option.

The Certificate Viewer window appears.
d) In the Details tab, click the Export option.
e) Select a Base-64 encoded option from the Save as type drop-down list.
f) Save the file to a location of your choice.

2. Per importare il certificato, esegui questi passaggi:
a) Open a command window.
b) Inserisci MMC per avviare la finestra della console.
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c) Select the Add/Remove Snap-in option from the File menu.
d) Double-click Certificates option and then select Computer account in the Certificates snap-

in window.
e) Click Next and select the Local Computer option in the Select Computer window.
f) Click Finish.
g) Fai clic su OK per tornare alla finestra della console.

3. Now add the certificates to the Trusted Root Certification Authorities and Trusted Publishers
folders.
a) Double-click the Certificates name.
b) Right-click the Trusted Root Certification Authorities name.
c) Select the Import option from the All Tasks menu.

Viene avviata la Procedura guidata di importazione dei certificati.
d) Fai clic su Avanti.
e) Click Browse and select the certificate that was saved.
f) Click Next and select the option to place all certificates in a store.
g) Click Next and click Finish to import the certificates.

Il certificato viene importato correttamente.
h) Repeat the above steps to import certificates in the Trusted Publishers folder.

La finestra della console ora mostra i certificati importati per l'utente corrente.

4. Riavvia il dispositivo Bot Agent per verificare che sia stato registrato correttamente.

Per ulteriori informazioni sulla risoluzione dei problemi, vedi Automation 360: Error while registering device -
An unexpected problem occurred (A-People login required).

Preparing for users
After completing initial installation and depending upon your deployment option, the post-installation
configuration and validation, you are ready to prepare for users to login and work with bots.
Consulta Utenti alla pagina 2683.

Licenze di prova
La licenza di prova della Automation Anywhere Control Room prevede un periodo di valutazione di 30
giorni. Ciò consente all'utente di valutare il prodotto e prendere una decisione oculata.
Le licenze di prova offrono tre Creatori di bot e due Esecutori di bot per iniziare; inoltre, è possibile
contattare l'amministratore di sistema o il reparto vendite Automation Anywhere per acquistare una nuova
licenza o estendere quella di prova.
Per acquistare una licenza estesa o installare una nuova licenza:
1. Accedi alla Control Room come amministratore; compare la home page del Dashboard.
2. Viene visualizzata una notifica con i giorni rimanenti prima della scadenza della licenza. Fai clic su

Mostra dettagli. Compare un messaggio con il collegamento a Installa una nuova licenza o
con l'indicazione di contattare l'amministratore di sistema o il reparto vendite Automation
Anywhere.
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Per visualizzare le statistiche di utilizzo e la licenza del bot, vai su Amministrazione > Fai clic su
Licenze.

Nota:  le statistiche relative alla licenza del prodotto e dell'utente bot sono visibili solo agli utenti con ruolo
di amministratore e con autorizzazione di gestione delle licenze.

La pagina Licenza mostra le statistiche relative alla licenza del prodotto e dell'utente bot con i relativi
dettagli.

Configurazione dell'autenticazione SAML
Switch an authenticated environment Control Room database to a SAML identity provider (IdP).

Nota:  L'integrazione SAML è irreversibile. After it has been established, you cannot modify the
configuration.

Ensure that you are logged in to the  as the administrator.
Before you set up authentication for the Control Room, setup tasks (such as introducing credentials on
a new system and importing users) might be required. If you import users, then you must also include
matching user IDs, email addresses, first and last names, in both the Automation Anywhere credentials
and matching records to log in after the SAML integration. For example, if using Okta as a SSO, then users
must have matching IDs, email addresses, first name and last names in both Automation Anywhere and
Okta to log in after the SAML integration.
You should have the required user information and certificate ready. Typical user information consists of
user ID, first and last name, and an email address.

Nota:  You must validate the SAML IdP setup before you configure the Control Room. Consulta Configure
the Control Room as a service provider alla pagina 979.

After switching to SAML authentication environments, any users with non-SAML IdP formatted IDs will not
be able to log in. You need to verify that any bots located in their private folders are exported so they can
be imported back against their new user accounts.
Much of this configuration relies on third-party applications to create the necessary metadata. If
you require more specific configuration information based on a specific provider, see Configure SSO
authentication with Okta alla pagina 996.
To switch the Control Room to a SAML-authenticated environment, follow these steps.
1. Navigate to Administration > Settings > User authentication.
2. Seleziona l'opzione Utilizza SAML.

Nota:  L'opzione Usa database Control Room è selezionata per impostazione predefinita.

3. Nel campo ID Unique Entity per la control room (provider di servizi), inserisci un ID entità
valido.

4. Nel campo Crittografa asserzioni SAML, seleziona una delle seguenti opzioni:
Opzione Descrizione

Non crittografare Le asserzioni SAML non sono crittografate.

Crittografa Le asserzioni SAML sono crittografate.

5. Opzionale: Inserisci i valori Chiave pubblica e Chiave privata.

Nota:  Inserisci le chiavi solo se sono necessarie asserzioni SAML crittografate.
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6. Fai clic su Convalida impostazioni SAML.
The Control Room will log in through the SAML provider and redirect back to the Control Room User
Authentication page.
Quando selezioni questa opzione, sarai reindirizzato a una pagina web del provider di servizi SAML 2.0
dove ti verrà richiesto di immettere le credenziali e altri dati.

7. Log in to your provider when prompted.
8. Fai clic su Salva modifiche.

Attività correlate
Configure the Control Room as a service provider alla pagina 979
A valid SAML IDP setup must be configured before the Control Room can be switched to a SAML-
authentication environment.

Configure SSO authentication with Okta
To log in after SAML integration, configure single sign-on (SSO) authentication with Okta as identity
provider (IDP).

Nota:  Okta is a third party and might update their user interface (UI) anytime. Hence, the Okta UI
references and images here are indicative and meant only for basic guidance.

Assicurati che siano soddisfatti i seguenti requisiti:
• The Control Room is a secure environment.
• A secure Automation 360 Cloud tenant is used.

1. Create a user in Okta and an admin account in Automation 360.

Nota:  The user must be created with the same User ID, , First Name, Last Name, and Email Address.
You might need to use email address for User ID. During testing, only email address is allowed in
Okta.

2. Generate an SSL certificate with private and public keys.
These keys are required to encrypt the communication between Okta and Automation 360.

3. Create app integration alla pagina 996.
4. Assign application to the user.
5. Configure the Control Room.
6. Validate the connection.

Create app integration
Configure Okta on a system before you import users and perform other setup tasks. Create SAML
integration in Okta and set the advanced settings and attributes.
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When you import users, ensure that they have a matching user ID, email address, first name, and last
name in both Automation 360 and Okta to log in after the SAML integration.
1. In Okta, navigate to Applications and click Create App Integration.

2. Select the SAML 2.0 sign-in method and click Next.
3. In the App name field, enter the name of the app and click Next.

4. Enter the Single sign-on URL.
It is the Assertion URL on the Control Room in the <CRURL>/v1/authentication/saml/assertion format.

5. Enter the Audience URI.
This can be any word or phrase (no spaces). Make note of this term to use in the Control Room
configuration.

6. Click Show Advanced Settings.
7. In the Advanced Settings section, select the Assertion Encryption as Encrypted.
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8. For Encryption Certificate, click Browse files and select the public key certificate that you
generated.

9. Scroll down to the Attribute Statements section and enter attributes, and then click Next.
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10. Select the appropriate option to notify whether you are a customer or a vendor, and then click Finish.

11. Scroll down and click View Setup Instructions.

The Identity Provider metadata field at the bottom is used in the Control Room configuration.

Assign application to user alla pagina 1000
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Assign application to user
After the application is created, assign it to the user.
1. In Okta, navigate to the Applications > Assignments tab.
2. Click Assign and select Assign to People.
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3. Click the Assign link that is next to the required user and confirm the assignment, and then click
Done.

Configure Control Room for Okta user alla pagina 1001

Configure Control Room for Okta user
After the application is assigned to the user, configure the Control Room for a user assigned in Okta.
1. Log in to the Control Room as the same user configured in Okta (User ID as Email address on both

systems).
2. Navigate to Administration > Settings > User authentication.
3. Select Use SAML.

Nota:  Use Control Room database is selected by default.

4. Nel campo ID Unique Entity per la control room (provider di servizi), inserisci un ID entità
valido.

5. Nel campo Crittografa asserzioni SAML, seleziona una delle seguenti opzioni:
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Opzione Descrizione

Non crittografare Le asserzioni SAML non sono crittografate.

Crittografa Le asserzioni SAML sono crittografate.

6. Opzionale: Inserisci i valori Chiave pubblica e Chiave privata.

Nota:  Enter the keys only if you require encrypted SAML assertions.

Validate the connection alla pagina 1002

Validate the connection
After the Control Room is configured, validate the SAML settings.
1. Fai clic su Convalida impostazioni SAML.

The Control Room will log in through the SAML provider and redirect back to the Control Room User
Authentication page.
When you click this option, you are redirected to a SAML 2.0 service provider web page where you are
prompted to enter the credentials and other data.

2. Log in to Okta when prompted and click Save changes.

Modifica profilo
Manage user profiles.
For users of Control Room configured with a non-directory environment, change the password, first name,
last name, and email address.
1. Click the Device icon and select Update credentials.

In the Control Room panel, click your username and select the My settings link.
2. In the Device login credentials section, enter the Username and Password for the device.

In the My profile section, click Edit.
Device login credentials are required to run a bot from this device.

Nota:  Automation 360 does not validate the device login credentials until you run a bot.

If your username is part of a domain, include the domain within the format domain\username.
Typically, home users are not part of a domain, unless they are specifically configured.
If your username contains non-ASCII characters, ensure your system locale settings are configured to
use these characters.
Configuring post-installation settings alla pagina 966

3. Enter information for general details, contact info and change password.
4. Click Update

Save the changes.

Installed Control Room directories and files
When installing the Automation Anywhere Control Room on different operating systems, the installer
executes and installs files and folders in the following directories.
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Window OS directory structure

When you install the Automation Anywhere Control Room on Windows OS, the default installation directory
for many configuration files is located:
C:\Program Files\Automation Anywhere\

Linux OS directory structure

When you install the Automation Anywhere Control Room on Linux OS, the installer creates the following
directories.

Directory path Descrizione Commenti

/opt/automationanywhere/automation360 All binary files

/opt/automationanywhere/automation360/
config

Config files

/var/log/automationanywhere/
automation360

Log files

/tmp Temporary files Directory that
contains temporary
files created by the
system and users.
Files under this
directory are
deleted when the
system is rebooted.

/opt/automationanywhere/automation360/
appdata/Server Files

Server files Control Room
repository folder.

/opt/automationanywhere/automation360/
_Automation 360_installation/Logs

Installer logs Installation logs
provide details
about issues during
installation, if any.

File di configurazione

Nota:  Automation 360 supports UTF-8 file encoding type. When you edit or create any Bot Agent or
Control Room configuration file, ensure to use UTF-8 file encoding type.

The minimum installed configuration files include:
• Chiavi di licenza per l'installazione - Richiedi lo strumento di installazione e le chiavi di licenza

appropriate al tuo account manager.
• Bot Creator schedules configuration files

• Nome del file del registro: logging.properties
• Log file location: <install_location>\config
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• File di configurazione per l'accesso automatico
• Nome del file di configurazione: autologinhelper-logging.xml
• Configuration file location: C:\Program Files\Automation Anywhere\Bot Agent\config

• File di configurazione del dispositivo
• Nome del file di configurazione: settings.properties
• Configuration file location: <install_location>\config

• Database configuration files
The database connection string is configured in:
• Nome del file di configurazione: boot.db.properties
• Configuration file location: <installation_location>\config

Additional configuration files that are created as needed, include:
• Cluster configuration

• Nome del file di configurazione: cluster.properties
• Configuration file location:<installation_location>\config\

• Key distribution center (KDC)
• Nome del file di configurazione: um.properties
• Configuration file location: <installation_location>\config\

• Parallel repository tuning
• Nome del file di configurazione: boot.server.properties
• Configuration file location: <installation_location>\config\

• Remote Desktop Protocol (RDP)
• Nome del file di configurazione: deployment.properties
• Configuration file location: <installation_location>\config\

• URL resources
• Configuration file name: DWMP_CONNECTIONS.properties
• Configuration file location: <installation_location>\DWAService\bin\src\main

\resources

• Trusted list restrictions
• Nome del file di configurazione: repository.properties
• Posizione del file di configurazione: <installation_location>\config\

• Gestione del carico di lavoro
• Nome del file di configurazione: wlm.properties
• Posizione del file di configurazione: <installation_location>\config

Stato fail-safe della Control Room
La Control Room si connette al server di licenze Automation Anywhere Cloud e ottiene i diritti di licenza
basati sulla chiave di licenza installata sulla Control Room.
La Control Room entra in modalità fail-safe in uno dei seguenti casi:
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1. Quando la Control Room non è in grado di connettersi al server delle licenze, passa allo stato fail-safe.
2. In caso di eccessivo utilizzo di licenze per la Control Room, questa passa allo stato fail-safe.

Per quanto riguarda il database del server delle licenze della Control Room, questa può trovarsi in uno dei
tre stati. Tali stati indicano quali operazioni di licenza utente possono essere eseguite. A ogni modifica di
stato, viene inserita una voce nel log di audit.

Attivo Operazioni normali. Il server di licenza accetta tutte
le chiamate API dalla Control Room.
Puoi assegnare agli utenti licenze mobili al
momento dell'accesso, che gli utenti possono
rilasciare quando si disconnettono.
Quando la Control Room viene riavviata ed è
operativa e viene stabilita la connessione al server
di licenze, la Control Room è nello stato Attiva:
• Agli utenti a cui erano state assegnate le licenze

prima della modalità provvisoria vengono
riassegnate le licenze originali.

• I nuovi utenti possono richiedere le licenze.

Fail-safe È consentita solo la chiamata all’API heartbeat
al server di licenza. Tutte le altre chiamate dalla
Control Room vengono interrotte.
• Soglia di attivazione fail-safe: Se la licenza

non riceve l'heartbeat dalla Control Room per
48 ore, il server delle licenze considera che la
Control Room stia funzionando in modalità fail-
safe. Questo periodo di 48 ore è chiamato soglia
di attivazione fail-safe.

Fail-safe scaduto La Control Room interrompe tutte le operazioni e
tutti gli utenti vengono disconnessi.
• Soglia di scadenza fail-safe: Dopo che il

server delle licenze sposta una Control Room in
modalità fail-safe, attende fino a 30 giorni per
ripristinare la licenza. Dopo 30 giorni, lo stato
viene modificato in Sospeso e sarà necessario
contattare l'assistenza tecnica per ripristinare la
modalità fail-safe della Control Room.

Attivazione fail-safe Scadenza fail-safe

A causa di perdita
di connessione

A causa di
consumo
eccessivo di
licenze

A causa di perdita
di connessione

A causa di
consumo
eccessivo di
licenze

Giorni Due giorni dopo
la perdita di
connessione

Due giorni dopo il
consumo eccessivo

30 giorni
dall'attivazione fail-
safe

30 giorni
dall'attivazione
fail-safe
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Attivazione fail-safe Scadenza fail-safe

A causa di perdita
di connessione

A causa di
consumo
eccessivo di
licenze

A causa di perdita
di connessione

A causa di
consumo
eccessivo di
licenze

Motivo Perdita di
connessione/
server di licenza
non funzionante

Consumo
eccessivo di
licenze. Se
vengono utilizzate
più licenze
utente di quelle
assegnate, la
Control Room
visualizza un
messaggio che
indica il consumo
eccessivo.

Perdita di
connessione/
server di licenza
non funzionante

Consumo
eccessivo di
licenze. (Il
consumo è
superiore rispetto
al numero di
licenze acquistate.)

Soluzione Ripristina la
connessione

Rilascia la
licenza utilizzata
in eccesso e
sincronizzala
con LS oppure
rinnova le licenze
consumate in
eccesso.
• Puoi rimuovere

le licenze
extra associate
agli utenti e
risincronizzarle
con il server
delle licenze
facendo clic su
Sincronizza
licenza dal
server.

Ripristina la
connessione

1. Rinnova
la licenza
utilizzata in
eccesso.

2. Apri un
ticket di
assistenza per
ripristinare
la modalità
fail-safe,
quindi rilascia
la licenza
consumata
in eccesso e
sincronizza
i dati con il
server delle
licenze.
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Attivazione fail-safe Scadenza fail-safe

A causa di perdita
di connessione

A causa di
consumo
eccessivo di
licenze

A causa di perdita
di connessione

A causa di
consumo
eccessivo di
licenze

Operazioni
possibili

1. Sono
consentite
solo
l'allocazione
e la
deallocazione
delle licenze. I
dati vengono
sincronizzati
successivamente
quando viene
ripristinata la
connessione.

2. Possono
accedere
sia gli utenti
amministratori
che quelli non
amministratori.

3. Il banner
viene
visualizzato
al momento
dell'accesso,
insieme al
messaggio di
errore nella
pagina della
licenza.

4. Le operazioni
RPA
continuano
normalmente.

1. Sono
consentite
tutte le
operazioni di
licenza.

2. Possono
accedere
sia gli utenti
amministratori
che quelli non
amministratori.

3. Il banner
viene
visualizzato
al momento
dell'accesso,
insieme al
messaggio
di errore
nella pagina
delle licenze
e all'errore
di consumo
eccessivo di
licenze.

4. Le operazioni
RPA
continuano
normalmente.

1. Solo l'utente
amministratore
può accedere.
Gli utenti non
amministratori
non possono
accedere.

2. Non sono
consentite
operazioni
sulle licenze

3. Il banner
viene
visualizzato
al momento
dell'accesso,
insieme al
messaggio di
errore nella
pagina della
licenza.

4. Le operazioni
RPA non
possono
continuare.

1. L'amministratore
può accedere
e installare
licenze.

2. Non sono
consentite
operazioni
sulle licenze

3. Il banner
viene
mostrato
l'ultimo giorno
prima della
chiusura della
Control Room,
insieme
all'errore di
consumo
eccessivo
sulla pagina
delle licenze.

4. Le operazioni
RPA non
possono
continuare.

Notifiche Dopo le 48 ore
iniziali, verrà
visualizzato un
banner nella tua
Control Room con
un messaggio
sul consumo
eccessivo.

On the 30th day,
you will see the
banner with a red
background and a
post that the user
will not be able to
log in. After the
30th day, you will
not be able to use
the Control Room.

Concetti correlati
Licenze e servizi cloud alla pagina 1008

© 2023 Automation Anywhere. All rights reserved.     1007



    Automation Anywhere - Installazione e aggiornamento Automation 360

Il portale Licenze e servizi cloud consente di gestire licenze, istanze delle Cloud Control Room e servizi
cloud RPA collegati al tuo account. Come partner o cliente Automation Anywhere, e un RPA, Control Room,
o amministratore IT, hai bisogno di gestire l'intero quadro di risorse IT in modo efficiente per realizzare il
valore dei tuoi investimenti.
Riferimenti correlati
Licenze Automation 360 alla pagina 1010
La pagina Tutte le licenze mostra informazioni dettagliate sulle licenze correnti di prodotti e dispositivi.
Notifiche di scadenza della licenza della Control Room alla pagina 1018
Le notifiche di scadenza della licenza della Automation Anywhere Control Room appaiono quando la licenza
della Control Room sta per scadere.

Licenze e servizi cloud
Il portale Licenze e servizi cloud consente di gestire licenze, istanze delle Cloud Control Room e servizi
cloud RPA collegati al tuo account. Come partner o cliente Automation Anywhere, e un RPA, Control Room,
o amministratore IT, hai bisogno di gestire l'intero quadro di risorse IT in modo efficiente per realizzare il
valore dei tuoi investimenti.
Le principali funzionalità fornite dal portale Licenze e servizi cloud sono la gestione delle licenze e la
gestione dei servizi cloud per clienti e partner.
I clienti possono eseguire le seguenti attività attraverso questo portale:
• Provisioning e gestione dei propri servizi cloud.
• Ricevere i dettagli sui GUID (Globally Unique Identifiers) delle licenze serviti dal cloud delle licenze.
• Configurare e scaricare i loro file di licenza (se applicabile).

I partner possono eseguire le seguenti attività attraverso questo portale:
• Provisioning e gestione dei propri servizi cloud e dei servizi cloud dei loro clienti.
• Ottenere dettagli sui propri GUID di licenze cloud e su quelli dei loro clienti serviti dal cloud delle

licenze.
• Configurare e scaricare i file di licenza per sé e per i propri clienti.

Panoramica

Per utilizzare e gestire in modo efficiente i loro ambienti, gli amministratori IT e RPA richiedono visibilità
sui diritti di licenza e una visione in tempo reale delle licenze disponibili e utilizzate. Inoltre, questi
amministratori richiedono visibilità sui servizi cloud e sulle istanze di servizi acquistati per gestire in modo
efficiente i requisiti RPA delle loro organizzazioni. Il portale aiuta questi utenti a raccogliere i dati e a
visualizzare e gestire le licenze e i servizi cloud.

Accesso al portale

Puoi accedere al portale Licenze e servizi cloud sul sito A-People. Devi avere un account su A-People, e
devi essere assegnato come utente designato del portale come parte del processo di vendita.
1. Accedi ad A-People utilizzando le tue credenziali di accesso: A-People home page (login required)

2. Fai clic sulla scheda Licenze e servizi cloud.
In alternativa, accedi direttamente a questa pagina selezionando il link fornito nell'email di benvenuto.
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Gestione delle licenze

Puoi gestire i seguenti tipi di licenze di prodotto attraverso il portale Licenze e servizi cloud:

Licenze Cloud Diritti di licenza software che sono distribuiti e
governati dal server di licenze cloud Automation
Anywhere. La Control Room si connette al server di
licenze cloud Automation Anywhere e ottiene i diritti
di licenza basati sulla chiave di licenza installata
sulla Control Room.
La chiave di licenza ha la forma di un GUID ed è
resa disponibile sul portale. Le istanze Automation
360Cloud e On-PremisesControl Room che hanno
accesso al server di licenze cloud possono usare le
licenze cloud.

Licenze di file Le licenze di file sono usate principalmente per
le versioni Automation Anywhere Enterprise 11 e
Enterprise 10 e per alcune distribuzioni Automation
360 On-Premises Control Room. Un file di licenza
per Control Room può essere generato dal portale e
installato manualmente sulla Control Room.

I clienti e i partner possono eseguire le seguenti attività relative alle licenze:
• Visualizza tutti i diritti di licenza e ottieni i dettagli delle licenze acquistate e disponibili e i termini di

abbonamento (date di inizio e fine della licenza).
• Configura e scarica i file di licenza, in base alle esigenze.
• Visualizza tutti i diritti di licenza e ottieni i dettagli dei GUID per le licenze cloud.
• Come partner, puoi visualizzare e gestire i diritti di licenza per la tua azienda e per i tuoi clienti finali.

Gestione dei servizi cloud

Utilizza il portale Licenze e servizi cloud per gestire i seguenti tipi di servizi Cloud Control Room:
• Pure Cloud Control Room
• Pure Cloud Sandbox Control Room
• Control Room abilitata al cloud
• Sandbox Control Room abilitata al cloud
• Migrazione nel cloud Control Room

Le istanze Pure Cloud Control Room e Pure Cloud Sandbox Control Room devono essere esplicitamente
fornite dal CLU (Customer License User) su richiesta quando il cliente è pronto a utilizzare il servizio cloud.
Control Room abilitata al cloud e Sandbox Control Room abilitata al cloud vengono forniti automaticamente
dal portale Licenze e servizi cloud, fornendo all'utente CLU un token necessario per installare la Control
Room abilitata al cloud sulla propria infrastruttura.
I clienti e i partner possono eseguire le seguenti azioni relativi ai servizi cloud:
• Visualizzare un inventario di tutti i servizi Cloud Control Room in abbonamento, con una visualizzazione

dei parametri di configurazione associati al servizio cloud.
• Eseguire il provisioning on-demand di servizi cloud, come Cloud Control Room e IQ Bot. Questo aiuta il

provisioning in tempo reale dei tuoi servizi.
• Accedere e gestire i servizi Control Room ordinati.
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• Migrare la produzione e i servizi Control Room QA.

Gestione delle licenze cloud e di file
Il portale Licenze e servizi cloud include le seguenti schede principali: Gestione delle licenze di file,
Gestione delle licenze cloud, Istanze delle Cloud Control Room e Prelievi dei partner.
Gestione delle licenze cloud
La scheda fornisce a clienti e partner la visibilità di tutti i diritti di licenza basati sul cloud e le chiavi di
licenza (GUID) da applicare a tutte le istanze delle Control Room del cliente.
Per Automation 360On-Premises, un utente designato può ottenere il GUID della Control Room da questa
scheda e incollarlo nella rispettiva istanza della Control Room. Consulta la sezione Installazione di licenze
aggiuntive alla pagina 2794.

Nota:  Per i clienti Automation 360Cloud che accedono per la prima volta, questa scheda è solo
informativa, perché quando viene eseguito il provisioning della Cloud Control Room per la prima volta, il
GUID è già applicato all'istanza della Control Room.

Gestione delle licenze di file
La scheda Gestione delle licenze di file fornisce a clienti e partner la visibilità di tutti i diritti di licenza
basati su file disponibili. Gli utenti delle licenze designati possono configurare un file di licenza per ciascuna
istanza delle Control Room con i diritti necessari. Per ulteriori informazioni, consulta le sezioni Manage
licenses alla pagina 2793 e Installazione di licenze aggiuntive alla pagina 2794.
I passaggi descritti di seguito offrono una guida al processo di licenza per Automation 360 e Enterprise 11.
1. Nella vista elenco della Control Room, fai clic sul nome della Control Roomdisponibile come

collegamento ipertestuale.
Il collegamento ipertestuale ti reindirizza alla pagina di configurazione della licenza, dove puoi
selezionare i diritti che vuoi aggiungere alla Control Room, quindi salvare e generare un file di licenza.

Nota:  Il portale impiega alcuni minuti per generare il file.

2. Usa il pulsante Aggiorna per vedere se il file di licenza è stato generato.
Dopo che lo stato della Control Room è diventato Attivo, puoi nuovamente fare clic sul nome della
Control Room e scaricare il file.

3. In base alle esigenze aziendali, puoi riconfigurare i file di licenza in qualsiasi momento dalla stessa
scheda.
Puoi configurare solo i diritti con lo stato Disponibile. Se tutti i diritti sono utilizzati nei file di licenza,
devi riconfigurare un file per rilasciare i diritti e renderli disponibili per essere aggiunti a un altro file di
licenza.

Per ulteriori informazioni, guarda i seguenti video:

Per i partner, la pagina mostra un ulteriore elenco a discesa che consente di cambiare contesto tra più
clienti che vengono gestiti. La pagina fornisce una vista simile, con un elenco a discesa aggiuntivo che
permette ai partner di cambiare il contesto tra i vari diritti dei clienti.

Licenze Automation 360
La pagina Tutte le licenze mostra informazioni dettagliate sulle licenze correnti di prodotti e dispositivi.
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Licenze di prodotto

Automation Anywhere Control Room è l'applicazione basata sul Web al centro della forza lavoro digitale che
fornisce gestione e controllo a livello aziendale. La Control Room garantisce la distribuzione e l'esecuzione
di bot affidabili, scalabili e sicuri. Da questo punto di osservazione centrale, gli operatori possono ricevere
attività dal Bot Creator e inviarle agli Bot Runners per l'esecuzione con semplici clic del mouse. Control
Room monitora e verifica tutti i bots pianificati e in esecuzione, in tempo reale.
Control Room fornisce un meccanismo automatico per il monitoraggio e il controllo dell'utilizzo del software
concesso in licenza nei Bot Creators e negli Bot Runners, in conformità con lo standard NIST CM-10 sulla
gestione delle modifiche.

Licenze dispositivi

La sezione licenze dispositivi mostra il numero di licenze acquistate, utilizzate e disponibili. Se le licenze
sono state aggiunte alla Control Room dal Cloud, la pagina Licenze mostra anche il numero di pagine
elaborate in altre istanze della Control Room.

Licenza Autorizzazione

Bot Creator Gli utenti con questa licenza possono creare, modificare,
programmare e attivare bots. Additionally, these users can
run bots in the following ways:
• Sulla loro macchina locale
• Dallo spazio di lavoro pubblico se l'amministratore

Control Room ha specificato Esegui come utente per
il Bot Runner non assistito

Bot Runner non assistito - Licenza di
runtime

Gli utenti con questa licenza possono eseguire tutte le
attività di automazione che gli utenti assistiti possono
eseguire. Inoltre, questa licenza può essere utilizzata
anche per la distribuzione della Automation Anywhere
Control Room, la programmazione centralizzata e la
distribuzione basata su API.

Nota:  Tra tutti i trigger, puoi associare qualsiasi trigger
solo con un utente che dispone di una licenza Bot Runner.
Inoltre, per un utente con licenza Bot Runner non assistita,
se associ trigger come Tasto di scelta rapida, Interfaccia o
Finestra, si applicano le seguenti condizioni:
• Il dispositivo predefinito non deve essere nello stato

disconnesso o bloccato.
• L'utente deve aver effettuato l'accesso al dispositivo per

eseguire un'attività predefinita che può attivare il bot.

Bot Runner assistito - Licenza di
runtime

Gli utenti con questa licenza possono eseguire i bots
sui loro dispositivi. Tuttavia, questi utenti non possono
eseguire o pianificare i bots su un altro dispositivo.
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Licenza Autorizzazione

Licenza Citizen Developer Gli utenti con questa licenza possono creare ed eseguire i
bots (anche bots con trigger) sui loro dispositivi.
Create a Citizen Developer role alla pagina 2707

IQ Bot pages (Number of pages) This license is required for uploading documents to
Automation 360 IQ Bot.

Standard Forms pages (Number of
pages)

This license is required for uploading documents for
processing in Standard Forms.

Google Document AI (Number of
pages)

Consente a Document Automation di elaborare i documenti
in Google Document AI.

Nota:  Questa metrica è visibile solo ai clienti che hanno
acquistato le licenze di Google Document AI tramite
Automation Anywhere.

Document Automation Standard Forms
(Number of pages)

This license is required for processing documents in
standard forms in Document Automation.

Document Automation 360 Extraction
(Number of pages)

This license is for processes documents in an Automation
Anywhere (Pre-trained) model, including the User-defined
document type.

IQ Bot Classifier Gli utenti con questa licenza possono caricare i documenti
in Classifier, dove i documenti vengono ordinati in gruppi di
documenti per migliorare l'accuratezza dell'estrazione.

Bot Insight Bot Insight fornisce analisi native RPA in tempo reale sia
per gli approfondimenti aziendali che per l'intelligenza
operativa.
La licenza di Bot Insight viene acquistata per utente. Per
accedere al dashboard Azienda, è necessario assegnare la
licenza all'utente.

Automation Anywhere Robotic
Interface (AARI)

Users with the Automation Anywhere Robotic Interface
license can be added to a Team for Process Composer
consumption. This allows them to create requests and
submit tasks within AARI

Discovery Bot Process Discovery licenses must be purchased for use
for business analysts and business users using Discovery
Bot. Discovery Botsupports two licenses. L'analista
aziendale utilizza la licenza dell'analizzatore di processi per
visualizzare e gestire i metadati da tutte le registrazioni
all'interno del processo. L'utente aziendale usa la licenza
del registratore di processi per visualizzare, registrare e
inviare un processo utilizzando il registratore Discovery Bot.

Controllo degli accessi basato su ruolo (RBAC) nella gestione delle licenze

L'accesso alla gestione delle licenze è basato su Nega tutti e Consenti per eccezione in base ai ruoli e
ai domini come definiti nel controllo degli accessi basato su ruolo (Role Based Access Control, RBAC).
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Solo gli utenti che hanno accesso all'autorizzazione di gestione licenze possono visualizzare i dettagli
dell’autorizzazione dalla Automation Anywhere Control Room.

Controlli dell'inventario di base: Bot Creators, Bot Runners e Bots

La Automation Anywhere Control Room gestisce tutte le operazioni di automazione. I controlli
dell'inventario vengono gestiti tramite l'applicazione di controllo degli accessi basato su ruolo per stabilire
un unico punto di controllo per le restrizioni di accesso alle configurazioni della linea di base (NIST
CM-2), per la gestione della configurazione (NIST CM-5 e 6). È possibile configurare i rapporti di base
automatizzati.

Licenze nei cluster a disponibilità elevata e nel ripristino di emergenza

Le informazioni sulle licenze, archiviate centralmente nel database o nel cloud delle licenze, sono condivise
all'interno dei cluster a disponibilità elevata e nei siti di ripristino di emergenza perché la replica sincrona
dei dati viene configurata tra più server della Control Room.
Modelli di distribuzione HA e DR alla pagina 885
Attività correlate
Installazione di licenze aggiuntive alla pagina 2794
Carica le nuove licenze in Automation Anywhere Control Room da distribuire agli utenti come richiesto.
Riferimenti correlati
Notifiche di scadenza della licenza della Control Room alla pagina 1018
Le notifiche di scadenza della licenza della Automation Anywhere Control Room appaiono quando la licenza
della Control Room sta per scadere.

Accessing Automation 360
Any new customer who orders our products receive license confirmation from Automation Anywhere.
The designated person responsible for configuring licenses for their company receives two email
confirmations.
The SSO email from sso@automationanywhere.com grants you access to set up a new
password for your Automation Anywhere Single Sign-On (SSO) account. The Orders email from
orders@automationanywhere.com grants you access to your license entitlement information.
Do the following:
1. Open SSO email → access link.
2. Enter and confirm new password.
3. Access A-People Community.
4. There are two options to access your license entitlements.

Opzione Azione

A-People Navigate to LICENSES.

Orders email Access link to redirect to license page.

Nota:  Your license entitlement validation date is provided within the context of the Orders email and
on the A-People License configuration page.

5. You now have access to your license entitlements.
On this page, you have access to more information of your order. The Product Versions shows
your current license entitlement version, the License Entitlements shows the number of license
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entitlements in your order, and the Control Rooms shows the number of control rooms in your order,
and allows to configure each licenses.

Provision Cloud Control Room instances
You can access, view, provision, and edit all the purchased Cloud Control Room instances. If required, you
can also purchase and provision the IQ Bot services later.
Use the Licenses and Cloud Services portal to provision Cloud Control Room and Cloud sandbox Control
Room instances on demand. Cloud-enabled Control Room instances are automatically provisioned by the
portal.
Customers can provision their own Cloud Control Room instances, and partner users can provision Cloud
Control Room for themselves and their customers.
1. Accedi ad A-People utilizzando le tue credenziali di accesso: A-People home page (login required).
2. Fai clic sulla scheda Licenze e servizi cloud.
3. Nel pannello di navigazione sul lato sinistro, fai clic su Istanze delle Control Room cloud per

visualizzare un elenco di istanze delle Cloud Control Room con e senza provisioning per i diversi tipi di
istanze delle Cloud Control Room.
Nella vista dell'inventario sono visualizzati i diversi parametri delle istanze delle Cloud Control
Room con provisioning, come il nome del dominio, l'URL della Control Room e la regione in cui
la Control Room è ospitata. Use the region name to subscribe to maintenance notifications on
status.automationanywhere.digital.

4. Inserisci un nome nel campo Nome della Control Room.
5. Nel campo Nome dominio della Control Room cloud, inserisci un nome di dominio.

Il nome del dominio deve essere univoco e farà parte dell'URL della Cloud Control Room. Il portale
controlla e convalida l'unicità del nome di dominio in tutto il sistema.
Prendi in considerazione i seguenti esempi di nomi di dominio:
• Example URL for Cloud Control Room: https://<domain-name>.my.automationanywhere.digital
• Example URL for Cloud sandbox Control Room: https://<domain-

name>.cloud#.automationanywhere.digital

Nota:  After provisioning is done, the domain name for a Cloud Control Room cannot be changed.

6. Seleziona un'opzione di ambiente.
Le opzioni sono Produzione, Sviluppo e UAT. By default, for sandbox Control Room, only the
sandbox option is displayed here.

7. Seleziona il Paese da dove la maggior parte dei tuoi utenti accederà a questa Control Room.
In base al Paese selezionato, la tua Cloud Control Room sarà ospitata nella regione più vicina.

Nota:  Dopo aver eseguito il provisioning, non è possibile cambiare il Paese per la Cloud Control
Room.

8. Select your Region.

Nota:  Dopo aver eseguito il provisioning, non è possibile cambiare la Regione per la Cloud Control
Room.

9. Seleziona e specifica l'amministratore della Cloud Control Room.
Puoi selezionarlo tra i contatti dei clienti esistenti o crearne uno. Se stai creando un utente, inserisci
dettagli come nome, cognome e indirizzo e-mail.
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10. Opzionale: If your account is entitled for IQ Bot service, you can register for IQ Bot by selecting the
check box.

11. Click Save to provision the Cloud Control Room instance.

The Cloud Control Room instance is automatically provisioned, and the Control Room status changes from
Provision to Provisioning in-Progress. Provisioning takes some time to complete. When provisioning is
complete, the status changes to Provisioning Complete.

Migrazione della Control Room self-service
Gestisci il processo di provisioning della migrazione con le funzionalità di auto migrazione e la flessibilità di
scegliere tra migrazione manuale o automatica.
To perform the task, you must have a  administrator account with the required rights and permissions.
Completa l'impostazione della Control Room per la migrazione al cloud prima di effettuare il provisioning di
un server IQ Bot con la Control Room, se il diritto appropriato è concesso in licenza.

Nota:  la migrazione non è attualmente supportata su GCP.

1. Accedi ad A-People utilizzando le tue credenziali di accesso: A-People home page (login required).
2. Fai clic sulla scheda Licenze e servizi cloud.
3. Nel pannello di navigazione sul lato sinistro, fai clic su Istanze delle Control Room cloud per

visualizzare un elenco di istanze delle Cloud Control Room con e senza provisioning per i diversi tipi di
istanze delle Cloud Control Room.
Nella vista dell'inventario sono visualizzati i diversi parametri delle istanze delle Cloud Control
Room con provisioning, come il nome del dominio, l'URL della Control Room e la regione in cui la
Control Room è ospitata. Usa il nome della regione per sottoscrivere le notifiche di manutenzione su
status.automationanywhere.digital.

4. Inserisci un nome nel campo Nome della Control Room.
5. Seleziona il tipo di migrazione.

• Migrazione Automation con Migration Utility. Per ulteriori informazioni, consulta Installazione
dell'utilità di migrazione Cloud alla pagina 1181.

• Migrazione manuale. Sarà disponibile una nuova Cloud Control Room con cui lavorare.

6. Nel campo Nome dominio della Control Room cloud, inserisci un nome di dominio.
Il nome del dominio deve essere univoco e farà parte dell'URL della Cloud Control Room. Il portale
controlla e convalida l'unicità del nome di dominio in tutto il sistema. Prendi in considerazione i
seguenti esempi di nomi di dominio:
Esempio di URL per Cloud Control Room Pure: https://<nome-
dominio>.my.automationanywhere.digital
Esempio di URL per Control Room Pure Cloud Sandbox: https://<nome-
dominio>.cloud#.automationanywhere.digital

7. Seleziona un'opzione di ambiente.
Le opzioni sono Produzione, Sviluppo e UAT. Per impostazione predefinita, per la Control Room
Sandbox viene visualizzata solo l'opzione Sandbox.

8. Seleziona il Paese da dove la maggior parte dei tuoi utenti accederà a questa Control Room.
In base al Paese selezionato, la tua Cloud Control Room sarà ospitata nella regione più vicina.

Nota:  Dopo aver eseguito il provisioning, non è possibile cambiare il Paese per la Cloud Control
Room.
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9. Seleziona la Regione.

Nota:  Dopo aver eseguito il provisioning, non è possibile cambiare la Regione per la Cloud Control
Room.

10. Seleziona e specifica l'amministratore della Cloud Control Room.
Puoi selezionarlo tra i contatti dei clienti esistenti o crearne uno. Se stai creando un utente, inserisci
dettagli come nome, cognome e indirizzo e-mail.

11. To generate the migration code, click Save.
The View tab displays the migration code.

12. Copy the migration code to the Cloud Migration utility. This will export and import the data to
Cloud.

Nota:  You can click the View tab for the following:
• View the migration code.
• Regenerate the migration code when the code is expired.
• Indicates that the Cloud Control Room is ready for use by displaying the user credentials.
• Displays the status of the Cloud Control Room during the migration process.

Nota:  During the migration process, you can view the stages of migration: New, Consumed, Expired,
Renewed, or Complete.

Visualizzazione dei dettagli della Control Room per la migrazione al cloud
In aggiunta agli altri dettagli mostrati per la Cloud Control Room standard, questa pagina mostra il codice
di migrazione utilizzato dall'utilità di migrazione.

Visualizzazione dei dettagli della Control Room per la migrazione al cloud

Gli utenti che attivano il provisioning e gli amministratori della Control Room per la migrazione al cloud
ricevono un'e-mail con le istruzioni su come ottenere il codice di migrazione, installare l'utilità di migrazione
e avviare il processo di migrazione.
Ecco alcune informazioni aggiuntive su questo processo, relative a Stato della migrazione, Codice di
migrazione e Data di scadenza del codice di migrazione.
Di seguito sono riportati i dettagli importanti di cui tenere traccia in questa pagina per gli amministratori:

Stato della migrazione Visualizza lo stato attuale della migrazione
Codice di migrazione Il codice necessario per completare il processo di

migrazione

Data di scadenza del codice di migrazione Se è stata superata la data di scadenza del
codice, è necessario generare un nuovo codice di
migrazione per la richiesta.

Manage and allocate licenses (partners)
Automation Anywhere partners can manage and process Licenses and Cloud services.
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Partners can manage their and their customers entitlements from the portal. Partners access the Licenses
and Cloud portal in the following ways:
• Purchases Automation Anywhere licenses for their own use.
• Participates in a customer purchases Automation Anywhere licenses through the partner.
• Partner draws down from their own license entitlements and allocates some portion of the entitlements

to a customer.

Use the Select an Account to switch entitlements via the drop-down list. Partners can view license
entitlements, configure licenses (file-based licensing), view Control Room GUIDs (cloud-based licensing),
and view and manage provision ready cloud services (Control Room, IQ Bot server).
For information, see Gestione delle licenze cloud e di file alla pagina 1010.
Assigning a customer and entitlements
To draw down on entitlements and assign to a customer, perform the following tasks.
1. Log in to the A-People portal: A-People home page (login required).
2. Click the Licenses and Cloud Services tab, and navigate to the Partner Draw downs tab.

An empty page is displayed when you log in for the first time. After a few requests have been
processed, this page displays a list of draw-downs that you have processed.

3. To start a new draw-down process, click New.
4. From the New Partner Draw Down Request page, select an order from the drop-down list.

You can draw down from only one order at a time.
5. Enter the required information in the following fields:

• Assign to customer account: Customer account name
• Customer website: URL to the customer's website
• Customer name: Name of your customer contact
• Customer email: Email address of the customer contact

6. After entering the customer information, generate a partner draw down request (PDR) by specifying a
number for each of the products available.

7. Click Save to generate a new PDR.
The PDR is in submitted state.
First, generate the PDR, an email notification is sent to your accounts team for approval.
Once the PDR is validated and approved (or rejected), the partner who requested for the PDR will
receive an email notification. The PDR requesting partner has to then navigate back to the portal to
take appropriate action.

8. After approval, click Accept.
After acceptance, the license entitlements from the PDR are transferred from the partner to the
customer. If the PDR is rejected, you can see the reason for rejection.

Nota:  If for any reason the draw down is no longer required, the partner can cancel the request at
this point.

9. Clone the PDR if required, make the necessary changes and resubmit the PDR.

Partners can refer to the customer documentation for managing licenses and provisioning cloud services.
• For configuring file licenses, see Configure new licenses.
• For provisioning of cloud services, see Provision Cloud Control Room instances alla pagina 1014.

The Licenses and Cloud portal provides the partners with an automated way to process draw downs for
their customers.
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View and edit Cloud Control Room instances
You can get a complete inventory view of all the Cloud Control Room instances and Migration Control
Rooms that have been purchased and linked to your account. You can check their provisioning status,
which can be Not Provisioned, Provisioning in progress, Provisioning complete, or Provisioning failed. You
can provision these instances as and when required.

1. Accedi ad A-People utilizzando le tue credenziali di accesso: A-People home page (login required).
2. Click the License and Cloud Services tab to open the Licenses and Cloud Services portal.
3. Nel pannello di navigazione sul lato sinistro, fai clic su Istanze delle Control Room cloud per

visualizzare un elenco di istanze delle Cloud Control Room con e senza provisioning per i diversi tipi di
istanze delle Cloud Control Room.
Nella vista dell'inventario sono visualizzati i diversi parametri delle istanze delle Cloud Control
Room con provisioning, come il nome del dominio, l'URL della Control Room e la regione in cui la
Control Room è ospitata. Use the Region name to subscribe to any maintenance notifications on
status.automationanywhere.digital.

4. Click the View option for any of the provisioned Cloud Control Room instances.
It opens the page with the details about the Cloud Control Room instances, such as name and domain
name, provisioning status, service type (Pure Cloud, Cloud-enabled, Cloud Sandbox, and so on),
license GUID, provisioning date, Cloud-enabled token, type of environment in which the instance is
deployed, and cloud region where the instance is hosted.

5. Opzionale: On the displayed page, click Edit to change the Cloud Control Room name to a name of
your choice.

6. If your account is entitled for an IQ Bot service, register for it by selecting the check box in the
displayed page.

7. Click Save to apply the changes in the page.

Notifiche di scadenza della licenza della Control Room
Le notifiche di scadenza della licenza della Automation Anywhere Control Room appaiono quando la licenza
della Control Room sta per scadere.
Quando la licenza della Control Room sta per scadere, l'amministratore visualizza un banner di notifica
quando accede alla Control Room. La Control Room controlla quotidianamente lo stato della licenza. 30
giorni prima della data di scadenza della licenza, viene visualizzato un messaggio di notifica nella Control
Room con il numero di giorni rimanenti alla scadenza della licenza. Il banner viene visualizzato ogni volta
che l'amministratore accede alla Control Room durante gli ultimi 30 giorni prima della scadenza della
licenza. La severità diventa critica negli ultimi 7 giorni prima della scadenza della licenza della Control
Room. Con l'avvicinarsi della data di scadenza, si ricevono sempre più notifiche, ai seguenti intervalli di
conto alla rovescia:
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• 30 giorni: Quando mancano 30 giorni alla scadenza di una licenza, nel banner della Control Room
viene visualizzata una notifica di disattivazione. Tale messaggio persiste nel banner finché la licenza non
viene rinnovata o non scade.

• 7 giorni: Quando mancano 7 o meno giorni alla data di scadenza della licenza, viene visualizzato un
banner rosso che mostra la data di scadenza e un link per estendere la licenza. Questa notifica viene
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visualizzata nella console finché il servizio non viene esteso o fino al termine del periodo di scadenza di
30 giorni.

• 0 giorni (scaduta): Una volta scaduta la licenza, non sarà più possibile utilizzare la Control Room.
Vedrai una schermata simile a quella riportata di seguito, con una notifica non ignorabile.

Nota:  In ambiente SSO, se l'opzione di installazione della licenza non viene visualizzata dopo la
scadenza della licenza, cancellare la cache del browser e aggiornare il browser. L'opzione installa licenza
diventa visibile.

Vedi anche

• Licenze Automation 360 alla pagina 1010
• Licenze e servizi cloud alla pagina 1008
• Stato fail-safe della Control Room alla pagina 1004
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Introduzione a Community Edition
Use these tasks to register for, and start creating and using bots with the Community Edition of Automation
360.
1. Register for the Automation Anywhere Community Edition:

a) Dal sito web Automation Anywhere https://www.automationanywhere.com scorri e fai clic sull'opzione
Ottieni Community Edition.
In alternativa, seleziona Clienti e partner > Community A People > Community Edition.
Scroll to the registration form: SCARICA SUBITO LA COMMUNITY EDITION.

b) Enter your identification information in the form that appears.
The form information includes your first name, last name, email, country, phone number, and
company. This information is used to create your Community Edition user login credentials.

Limitazione:  Only the period/dot (.) and at sign (@) are allowed in the email field. No other
special characters are supported.

c) Read and agree to the terms, privacy policy, and license agreement. Seleziona e fai clic su Invia.
Wait for the email from Automation Anywhere that contains the information for you to log in to
the Community Edition. The email includes the Community Control Room URL, your username,
and assigned user password. After you log in, you are prompted to reset your password.

2. Accesso alla Automation Anywhere Control Room alla pagina 1022.
Per accedere a Automation 360, apri l'URL Control Room nel browser, immetti le credenziali nella
schermata di accesso e fai clic su Accedi.

3. Install the Bot Agent, register your device, and set user device credentials.
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039 | Set user device credentials alla
pagina 1052
The Bot Agent is a lightweight application that enables you to run bots on your device by connecting
the device to the Control Room. To run bots on a local machine, install the Bot Agent and add the local
device to the list of enabled host devices.
Per abilitare un dispositivo per l'esecuzione di bots, imposta le credenziali del dispositivo locale.
If you are using an operating system other than Windows, you will not be able to install the Bot Agent
at this time. Vedi requisiti di sistema. Tuttavia, è comunque possibile creare bots utilizzando Bot editor.

4. Creazione del primo bot alla pagina 1059.
Segui questi passaggi per creare il primo bot che stampa il messaggio Go be great!, la versione
Automation Anywhere di Hello World!

5. Run your first bot alla pagina 1062.
Esegui un bot dallo stesso dispositivo utilizzato per creare il bot.

Watch the following videos that illustrate some of the steps in this task:
• Installing the Bot Agent in Automation 360:

• Building your first bot:

• Running your first bot in the Community Edition:
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Community capacity and limitations
Community users access and bot creation and running conditions.

Number of bots creators per Community
Edition user

Each Community Edition user can use one Bot
Creator and one attended Bot Runner at a time.
Community Edition user does not have access to
unattended Bot Runner licenses.

Number of bots created by Community
Edition user

Each Community Edition user can create multiple
bots.

Number of registered devices per Community
Edition user

Each Community Edition user can register multiple
devices, but only be logged in to one at a time, and
only run a bot on one device at a time.

Number of bots run by Community Edition
user

Each Community Edition user can run one bot at a
time on any one registered device.

Export bots function for Community Edition
user

Community Edition user cannot export bots from
the Control Room.

Import bots function for Community Edition
user

Community Edition user cannot import bots
downloaded from the Bot Store to the Control
Room.

Nota:  In addition to these limitations, Community users do not have access to administrator settings, Bot
Insight, Bot Runner, IQ Bot, AARI, and Center of Excellence (CoE). To access these settings and features,
you must upgrade to Automation 360.

Accesso alla Automation Anywhere Control Room
Per accedere a Automation 360, apri l'URL Control Room nel browser, immetti le credenziali nella
schermata di accesso e fai clic su Accedi.
Riceverai l'e-mail di conferma della registrazione.
• Utenti di Automation 360: Viene inviato dall'amministratore di sistema.
• Utenti di Community Edition:

1. Registrati a Community Edition.
Introduzione a Community Edition alla pagina 1021

2. Viene inviato da Automation Anywhere utilizzando le informazioni fornite al momento della
registrazione.

Questa e-mail contiene:
• URL Control Room
• Nome utente, credenziali e token di provisioning (ove applicabile)
• Password temporanea

Reimposta questa password quando accedi per la prima volta.

Nota:  If you use the Microsoft Internet Explorer browser to log in to the Control Room, a notification
banner is displayed indicating that support for Internet Explorer 11 is ending. Non sarà più possibile
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accedere alla Control Room da Internet Explorer. Starting from the Automation 360 v.25 release, you
will be prompted to access the Control Room through an alternative supported browser, such as Google
Chrome or Microsoft Edge (Chromium). Refer to the banner for details on how you can evaluate any
potential impact to your existing automations. Microsoft Internet Explorer 11 EOL FAQ alla pagina 770

1. Apri l'URL nel browser.
2. Nel modulo Accedi inserisci il tuo nome utente e la password.

Se è la prima volta che effettui l'accesso, usa la password fornita nella tua e-mail di benvenuto.
3. Utenti che accedono per la prima volta: cambiare la password. Per gli utenti Cloud, creare le

domande di sicurezza.
Il modulo di modifica della password e di creazione delle domande di sicurezza viene visualizzato
automaticamente al primo accesso. Compila il modulo.
a) Completa i campi di Cambia password.

Inserisci la password attuale, inserisci la nuova password e confermala.
Le password devono essere lunghe 8-15 caratteri e possono contenere solo i seguenti caratteri: a-
z, A-Z, 0-9, segno (@), trattino (-), trattino basso (_), punto esclamativo (!), simbolo del numero
(#), simbolo del dollaro ($), percentuale (%), e commerciale (&) e punto (.).

b) Per gli utenti Cloud: In ogni coppia di campi di domanda e risposta, inserisci una domanda e
una risposta che ricorderai se dimentichi la tua password o se devi confermare il tuo accesso.

c) Fai clic su Salva e accedi.

Dopo il primo accesso, per cambiare la password, fai clic sul tuo username, seleziona Cambia
password e completa il modulo.

4. Opzionale: Seleziona Ricorda il mio nome utente per accedere rapidamente alla Cloud Control
Room.

5. Opzionale: Fai clic su Password dimenticata? per reimpostare la password.
Ti verrà inviata un'e-mail con un link alla pagina necessaria per reimpostare la password dell'account.

6. Fai clic su Accedi.
Le credenziali vengono autenticate direttamente con il database di Cloud Control Room o Community
Control Room.

Nota:  Quando si accede alla Control Room Enterprise con l'opzione Accesso con Windows
selezionata, è necessario inserire l'FQDN per accedere.

Nota:  Il tuo account verrà bloccato se digiti la password sbagliata per un determinato numero di
volte, a seconda dei criteri delle password impostati dall'amministratore. Per motivi di sicurezza, i
tentativi di accesso non riusciti vengono verificati. Ciò consente all'amministratore di analizzare e
adottare le azioni appropriate.

Attività correlate
Creazione del primo bot alla pagina 1059
Attieniti alla seguente procedura per creare il primo bot che stampa il messaggio Go be great!, la
versione Automation Anywhere di Hello World!
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039
Install Bot Agent on your local device and connect it to Control Room. In order to run bots on that local
device, ensure that you add it to the list of enabled host devices.
Reset user password alla pagina 2692
The Control Room administrator generates an email process for the user to reset their password.
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Informazioni su Bot Agent
The Bot Agent is a lightweight application that enables you to run bots on your local device by connecting
it to Control Room. After installing the Bot Agent on a device, a registered user with role-based access
privileges can create, manage, and deploy bots on that device.

Bot Agent configuration

1. A Control Room administrator creates and shares the user credentials. You can then log into Control
Room using these sign in credentials.

2. After signing into Control Room, you install the Bot Agent and register your local device. This device is
then mapped to your username in Control Room.

3. The Bot Agent is registered as a Windows service (Automation Anywhere Bot Agent Service) on your
device and the Automation Anywhere extension is added to your browser.

4. The device communicates with the Control Room using WebSocket and stays connected.

Privilege mapping

A user is granted privileges governed by role-based access and assigned a device license by a Control
Room administrator. User is assigned a Bot Creator or Bot Runner license.
Bot Creator
Users with this license can log into the Control Room from a browser to perform the following actions:
• Create, edit, or delete bots.
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• Manage bots for using in Bot Insight, IQ Bot, and Bot Store.

Bot Runner
Users with this license can deploy bots from the Control Room. Additionally, a user can be assigned one of
the following Bot Runner licenses:
• Unattended Bot Runner license

Users with this license are can allow other Control Room users with the required role to run and
schedule automations in Control Room. These users are also referred as Run as users.

• Attended Bot Runner license
Users with this license are allowed to run attended automations on their devices from the Control
Room.

Nota:  If you encounter black screen when running bots in unattended mode, see the following article for
troubleshooting steps.
Black screenshot while running the bot in unattended mode (A-People login required)

Attività correlate
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039
Install Bot Agent on your local device and connect it to Control Room. In order to run bots on that local
device, ensure that you add it to the list of enabled host devices.
Riferimenti correlati
Compatibilità di Bot Agent alla pagina 1025
Prima di installare Bot Agent, assicurati che sia compatibile con l'hardware e il software del tuo ambiente.

Compatibilità di Bot Agent
Prima di installare Bot Agent, assicurati che sia compatibile con l'hardware e il software del tuo ambiente.
The latest version of Bot Agent is available for download and is compatible with the Control Room version
that is used.

Guidelines

• When you update the Bot Agent in Windows Server 2012 or earlier versions of the operating system,
you might encounter unexpected system reboots during the update because of the limitations in the
operating system.

• When the Bot Agent update is optional, you can continue to use the Bot Agent from any of the previous
(optional) releases, which will be compatible with the current release. For example, the Bot Agent
update is optional for v.26. So you can continue to use the Bot Agent from v.25 release.
You can download and install the latest version of Bot Agent anytime on your device. However, an alert
on the availability of a newer Bot Agent version is displayed on the login screen if you are connected to
a device that is running an older version of Bot Agent.

• If you want to use the latest version of packages from a new release, you might be required to update
to the latest version of the Bot Agent even if it is optional.
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Compatibility with release builds

Versione
Automation 360

Build di Automation 360 Versione Bot
Agent

Aggiornamento
Bot Agent

Automation 360
v.28

• Build 17464 (Cloud-Sandbox)
• Build 17464 (Community Edition)

• 21,240
• 21,240

Facoltativo

Automation 360
v.27

• Build 16685 (On-Premises)
• Build 16701 (Cloud)
• Build 16701 (Community Edition)

• 21,230
• 21,230
• 21,230

Facoltativo

Automation 360
v.26

• Build 15459 (On-Premises)
• Build 15459 (Cloud)
• Build 15450 (Community Edition)

• 21,222
• 21,222
• 21,222

Facoltativo

Automation 360
v.25

• Build 15112 (On-Premises)
• Build 14304 (Cloud)
• Build 14304 (Community Edition)

• 21,210
• 21,210
• 21.210.14966

Facoltativo

Patch v.24R2 di
Automation 360

• Build 13343 (Cloud, On-Premises
GA, Sandbox, Community Edition)

• Build 13331 (On-Premises pre-GA)

• 21,200
• 21.1000.14009

Build pre-GA
On-Premises:
Disinstalla
Bot Agent
21.1000.14009 e
installa Bot Agent
21.200.

Facoltativo

Automation 360
v.24

• Build 12350 (On-Premises)
• Build 12350 (Cloud)
• Build 12350 (Community Edition)

• 21.134 (On-
Premises)

• 21.134 (Cloud)
• 21.134

(Community
Edition)

Facoltativo

Automation 360
v.23

• Build 11513 (On-Premises)
• Build 11513  (Cloud)
• Build 11524 (Community Edition)

• 21.121.12191
(On-Premises)

• 21.121.12191
(Cloud)

• 21.121.12202
(Community
Edition)

Facoltativo
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Versione
Automation 360

Build di Automation 360 Versione Bot
Agent

Aggiornamento
Bot Agent

Automation 360
v.22

• Build 10526 (On-Premises)
• Build 10535 (Cloud e Community

Edition)

• 21.98.11198
• 21.100.11213

Facoltativo

Automation 360
v.21

• Build 9664 (On-Premises)
• Build 9664 (Cloud e Community

Edition)

• 21.82.10342
• 21.82.10342

Obbligatorie

Enterprise
A2019.20

• Build 8815 (On-Premises)
• Build 8846 (Cloud)

• 20.17.9493
(On-Premises)

• Cloud:
• 20.18.9528

(per Stati
Uniti
occidentali e
Giappone)

• 20.17.9518
(per regioni
diverse da
Stati Uniti
occidentali e
Giappone)

Obbligatorie

Enterprise
A2019.19

• Build 8147 (On-Premises)
• Build 8145 (Cloud e Community

Edition)

• 18.12.8825
• 18.12.8823

Obbligatorie

Enterprise
A2019.18

Build 7560 (Cloud, On-Premises e
Community Edition)

16.19.8238 Facoltativo

Enterprise
A2019.17

Build 7103 (Cloud, On-Premises e
Community Edition)

16.7.7774 Obbligatorie

Enterprise
A2019.16

Build 6463 (Cloud, On-Premises e
Community Edition)

14.3.7141 Obbligatorie

Enterprise
A2019.15

Build 5933 (Cloud, On-Premises e
Community Edition)

12.7.6609 Facoltativo

Enterprise
A2019.14

Build 5322 (Cloud, On-Premises e
Community Edition)

12.1.6000 Obbligatorie

Enterprise
A2019.13

• Build 4705 ( On-Premises)
• Build 4701 (Cloud e Community

Edition)

• 9.0.5383
• 9.0.5379

Obbligatorie

Enterprise
A2019.12

• Build 4111 (Cloud e Community
Edition)

• Build 4105 (On-Premises)

• 7.0.4789
• 7.0.4783

Obbligatorie
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Versione
Automation 360

Build di Automation 360 Versione Bot
Agent

Aggiornamento
Bot Agent

Enterprise
A2019.11

Build 3337 (On-Premises, Cloud e
Community Edition)

6.0.4015 Obbligatorie

Enterprise
A2019.10

Build 2545 (Cloud, On-Premises e
Community Edition)

3.3.3211 Facoltativo

Enterprise
A2019.09

Build 2094 (Cloud, On-Premises e
Community Edition)

3.0.2772 Obbligatorie

Enterprise
A2019.08

• Build 1610 (solo On-Premises)
• Build 1598 (Cloud e Community

Edition)

• 1.0.2288
• 1.0.2276

Facoltativo

Enterprise
A2019.07

• Build 1089 (solo On-Premises)
• Build 1082 (Cloud e Community

Edition)

• 1.0.1767
• 1.0.1760

Facoltativo

Enterprise
A2019.06

Build 543 (Cloud, On-Premises e
Community Edition)

1.0.1221 Facoltativo

Enterprise
A2019.05

Build 336 (Cloud, On-Premises e
Community Edition)

1.0.1014 Obbligatorie

For information on Bot Agent device requirements, see Device requirements for Bot Agent alla pagina 1031.
Attività correlate
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039
Install Bot Agent on your local device and connect it to Control Room. In order to run bots on that local
device, ensure that you add it to the list of enabled host devices.
Riferimenti correlati
Matrice di confronto delle funzionalità per Automation 360 alla pagina 722
Puoi utilizzare la matrice di confronto delle funzionalità per confrontare le funzionalità di Automation 360
con le funzionalità di Automation Anywhere Enterprise 11.3.x e delle versioni Enterprise 10.
Universal Recorder supported applications and browsers alla pagina 1958
Use the Universal Recorder to record interactions with objects from the supported technologies.

Supporto per l'accesso automatico per Bot Agent
L'accesso automatico viene utilizzato per accedere automaticamente a un dispositivo, eseguire
un'automazione pianificata e ripristinare lo stato originale di blocco o disconnessione del dispositivo dopo
l'esecuzione dell'automazione.
The Run as user device credentials are used for Auto-login. L'accesso automatico ripristina lo stato
originale di un dispositivo nei seguenti scenari:
• Automation was stopped on the Control Room or device.
• An error in encountered during bot execution.
• When the automation completed successfully.
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Auto-login support: operating system

Identify the operating system support specific to auto-login on Bot Agent devices. The auto-login process
involves several stages and depends on the Bot Agent activity.
The following scenarios are supported on Windows 10 and virtual machines only:

SID# Scenario

1 No user session established (user is not logged in)

2 User session established

3 User has logged in but locked the screen

4 A different user (not the device login user used for deployment) is logged
in

5 A different user is logged in and locked the screen

6 Fast user switching

The following scenarios are applicable and supported on Windows Server 2019, Windows Server 2016,
Windows Server 2012 R2, Windows 10, 8, and 7:

SID# Scenario

1 No active RDP session

2 User has active RDP session

3 User's RDP session is disconnected

4 User's RDP session is locked

5 Another user has active RDP session

6 Another user has a disconnected session

7 Another user has an active session and locked

Auto-login support: operating system with cloud platform

The following table identifies the support specific to auto-login on Bot Agent devices for operating system
across cloud platforms:

SID# Scenario Supported OS

1 No active RDP session • Windows 2019 - AWS
• Windows 2016 R2 - AWS
• Windows 2012 R2 - AWS
• Windows 10 AWS
• Windows 11 (Enterprise)
• Windows 10 Azure (Enterprise)
• Windows 10 VMWare (ESXi 6.7 and Horizon)
• Windows 10 Citrix
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SID# Scenario Supported OS

2 User has active RDP session • Windows 2019 - AWS
• Windows 2016 R2 - AWS
• Windows 2012 R2 - AWS
• Windows 10 AWS
• Windows 11 (Enterprise)
• Windows 10 Azure (Enterprise)
• Windows 10 VMWare (ESXi 6.7 and Horizon)
• Windows 10 Citrix

3 User's RDP session is
disconnected

• Windows 2019 - AWS
• Windows 2016 R2 - AWS
• Windows 2012 R2 - AWS
• Windows 10 AWS
• Windows 11 (Enterprise)
• Windows 10 Azure (Enterprise)
• Windows 10 VMWare (ESXi 6.7 and Horizon)
• Windows 10 Citrix

4 User's RDP session is locked • Windows 2019 - AWS
• Windows 2016 R2 - AWS
• Windows 2012 R2 - AWS
• Windows 10 AWS
• Windows 11 (Enterprise)
• Windows 10 Azure (Enterprise)
• Windows 10 VMWare (ESXi 6.7 and Horizon)
• Windows 10 Citrix

5 Another user has active
RDP session

• Windows 2019 - AWS
• Windows 2016 R2 - AWS
• Windows 2012 R2 - AWS
• Windows 10 AWS
• Windows 11 (Enterprise)
• Windows 10 Azure (Enterprise)
• Windows 10 VMWare (ESXi 6.7 and Horizon)
• Windows 10 Citrix

6 Another user has a
disconnected session

• Windows 2019 - AWS
• Windows 2016 R2 - AWS
• Windows 2012 R2 - AWS
• Windows 10 AWS
• Windows 11 (Enterprise)
• Windows 10 Azure (Enterprise)
• Windows 10 VMWare (ESXi 6.7 and Horizon)
• Windows 10 Citrix
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SID# Scenario Supported OS

7 Another user has an active
session and locked

• Windows 2019 - AWS
• Windows 2016 R2 - AWS
• Windows 2012 R2 - AWS
• Windows 10 AWS
• Windows 11 (Enterprise)
• Windows 10 Azure (Enterprise)
• Windows 10 VMWare (ESXi 6.7 and Horizon)
• Windows 10 Citrix

Additional notes on auto-login:
• L'accesso automatico è supportato solo sui sistemi operativi a 64 bit.
• L'accesso automatico non è in grado di disconnettere la sessione Admin root, quando si tenta di farlo in

scenari che coinvolgono due diversi utenti con accesso automatico. Remember to log out of the admin
user account before deploying a bot.

• For scenarios 4, 5, and 6 in the above tables, the active user is logged off and a new session created
with device credentials for deploying the bot.

Concetti correlati
Manage device settings alla pagina 2727
Control Room administrator can configure the device settings to automatically set a user's default device
when that user logs into Control Room.
Attività correlate
Configure auto-login settings alla pagina 2732
Configure auto-login settings in the Control Room to either create user sessions or reuse existing user
sessions to reduce the bot startup time.
Riferimenti correlati
Compatibilità di Bot Agent alla pagina 1025
Prima di installare Bot Agent, assicurati che sia compatibile con l'hardware e il software del tuo ambiente.

Device requirements for Bot Agent
Review the Bot Agent device requirements such as hardware components, compatible devices, supported
operating systems and browser extensions.

Requisiti hardware

Puoi installare il Bot Agent su dispositivi che soddisfano i seguenti requisiti hardware.
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Dispositivo Processor RAM Storage (free disk
space)

Network

Macchina Intel Core i3 2.6
GHz with 4 multi-
cores or higher
64-bit

• 4 GB
(Minimum)

• 8 GB
(Recommended)

32 GB
Add 100 through
150 KB per
Automation
Anywhere script
Add 40 through 50
GB per long-term
project

• 5Mbps
(Minimum)

• 20Mbps
or higher
(Recommended)

Utenti aggiuntivi
su un dispositivo
multi-utente

2 CPU per
additional user

4 GB per
additional user

Non è richiesto
altro spazio di
archiviazione

Nessuna rete
aggiuntiva
necessaria

Additional RAM requirements for the
registered devices

Add additional RAM to account for applications
and services running on the registered devices, for
example:
• Applicazioni di Microsoft Office (esempio: Excel)
• Browser (esempio: Google Chrome)
• Applicazioni aziendali (esempio: CRM, Oracle

EBS e SAP
• VDI infrastructure applications
• Anti-virus software
• AISense Recorder

Additional disk space on registered devices • Automation 360 scripts average approximately
100-150 KB. Additional free disk space is
required to develop automation projects because
temporary files such as screenshots, server logs,
and audit files are created during the execution
of the automation scripts.

• Free space required increases with the project
size. Recommendation: Have at least 40-50 GB
of free disk space for each long-term project.

• Increase storage space configuration after
installation, as needed, depending on product
usage. For example, depending upon the
complexity of your bot, generating log files and
logic creation require additional disk space later.

Compatibilità del dispositivo

Un dispositivo che esegue Bot Agent deve soddisfare i seguenti requisiti per eseguire operazioni di
automazione:

Nota:
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• I requisiti del dispositivo sono diversi per Control Room e Bot Agent.
Per la compatibilità della Control Room, vedi Sistema operativo, ambiente e piattaforma supportati per la
Control Room alla pagina 850

• Per far funzionare correttamente il tuo dispositivo su Amazon Workspaces, aggiorna il
registro su tutti i computer Workspace rinominando il file spacedeskHookKmode.sys come
spacedeskHookKmode.sys.old in C:\Windows\System32\drivers. Riavvia il computer e
verifica che STXHD Hosted Application Service non sia in esecuzione.
Per ulteriori informazioni, consulta Troubleshooting Amazon WorkSpaces issues.

Computer On-Premises Macchine fisiche in esecuzione su sistemi operativi
supportati.

Server di terminale Desktop remoto (RDP) in esecuzione su sistemi
operativi supportati da Enterprise A2019.11 o
versioni successive.

Macchine virtuali Da Enterprise A2019.09 o versioni successive, è
possibile installare Bot Agent su tutte le macchine
virtuali (VM) con il sistema operativo Windows
supportato.
Affinché il registratore AIsense funzioni su una
macchina virtuale, abilita le istruzioni AVX sia per
Bot Runner che per Bot Creator.
Per i dettagli, vedi Automation 360: AI Sense Recorder
is crashing (A-People login required)

Bot Agent è certificato su tutte le principali versioni
di VM e supporta quanto segue:

Macchina virtuale (VM) Sistema operativo e
versione

Amazon Web Services
EC2

• Windows 11
(Enterprise)

• Windows 10
(Professional)

• Windows 2012
Server, Windows
2016 Server e
Windows 2019
Server (Standard e
Datacenter)

Amazon Web Services
WorkSpaces (bundle
Performance)

• Windows 11
(Enterprise)

• Windows 10
(Professional)
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Macchina virtuale (VM) Sistema operativo e
versione

Google Compute
Engine

• Windows 11
(Enterprise)

• Windows 10
(Professional)

• Windows 2012
Server, Windows
2016 Server e
Windows 2019
Server (Standard e
Datacenter)

Microsoft Azure
Macchina virtuale (VM)

• Windows 11
(Enterprise)

• Windows 10
(Professional e
Enterprise)

• Windows 2019
Server (Datacenter)

Microsoft Azure
Windows Virtual
Desktop (WVD)

• Windows 11
(Enterprise)

• Windows 10
(Enterprise)

VM VMware su ESXi 6.x • Windows 10
(Professional)

• Windows 2016
Server

Citrix XenDesktop (VDI) Windows 2016 Server

VM Citrix • Windows 10
(Enterprise)

• Windows 2016
(Server)

VMware Horizon Windows 10
(Enterprise)

Windows 365 Cloud PC Windows 11
(Enterprise)

Nota:  Quando installi Bot Agent su macchine
virtuali, assicurati di modificare le impostazioni di
Alimentazione e Sospensione della macchina
virtuale su Mai in modo che le distribuzioni di bot
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da Control Room possano essere eseguite senza
interruzioni.

Compatibilità del sistema operativo

Puoi installare Bot Agent su computer che eseguono i seguenti sistemi operativi.
Questa compatibilità si applica a On-Premises, distribuzioni di Cloud e Community Edition di Automation
360.

Nota:
• È supportata solo la versione a 64 bit del sistema operativo.
• Le attività Bot Creator sono supportate con tutti i sistemi operativi elencati.
• Bot Agent non può essere installato su sistemi Linux. Non puoi registrare un dispositivo in esecuzione

su un sistema Linux. Tuttavia, è possibile utilizzare un dispositivo registrato in esecuzione su un sistema
Windows per accedere a una Control Room installata su un sistema Linux.

Windows version Windows edition Bot Runner
assistito

Bot Runner non
assistito

Bot Creator

Windows Server
2019

Datacenter e
Standard

Supported Supportato1 Supported

Windows Server
2016

Datacenter e
Standard

Supported Supportato1 Supported

Windows Server
2012

Datacenter e
Standard

Supported Supportato1 Supported

Windows 11 Enterprise Supported Supportato1 Supported

Windows 10 Professional and
Enterprise

Supported Supportato1 Supported

Windows 8 2 Professional and
Enterprise

Supported Supported Supported

Windows 7 2 Professional and
Enterprise

Supported Supported Supported

(1) Auto-login • Auto-login is only supported on 64-bit systems.
• Se l'accesso automatico non riesce, configura le

impostazioni Criteri di sicurezza locali. For
example, in Windows, select Security Settings
> Local Policies > Security Options. Enable
the Interactive logon > Do not require
CTRL+ALT+DEL option.

(2) Supported OS Windows 11 (64-bit) supported on Automation 360
Build 15459 or later.
Windows 8 (64-bit) supported on Enterprise A2019
(Builds 1598 and 1610) or earlier.
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Windows 7 (64 bit) supportato su Enterprise
A2019.12 o successiva.

Compatibilità con il browser

L'interfaccia utente di Bot Agent viene eseguita su un browser. Accedi a Automation 360 utilizzando i
browser supportati per installare e registrare il tuo dispositivo.
Per un elenco dei browser supportati, consulta Browser supportati alla pagina 867

Estensioni supportate

Quando colleghi il tuo dispositivo Bot Agent alla Control Room, puoi abilitare le estensioni supportate dal
tuo browser per registrare le automazioni.
Per un elenco delle estensioni supportate, vedere Estensioni per l'automazione alla pagina 870

Supporto per l'accesso automatico

L'accesso automatico viene utilizzato per accedere automaticamente a un dispositivo, eseguire
un'automazione pianificata e ripristinare lo stato originale di blocco o disconnessione del dispositivo dopo
l'esecuzione dell'automazione.
Per il supporto del sistema operativo specifico per l'accesso automatico ai dispositivi Bot Agent, vedi
Supporto per l'accesso automatico per Bot Agent alla pagina 1028

Working with Bot Agent
Users can perform tasks based on their assigned role after installing the Bot Agent on their device.
1. Review the prerequisites to install the Bot Agent are complete.

Compatibilità di Bot Agent alla pagina 1025
2. Install Bot Agent on your device.

• Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039
• Bulk install Bot Agent on devices alla pagina 1053

3. In order to deploy bots on your device, connect the Bot Agent to your device using an authentication
proxy and ensure that the changed proxy setting or credentials are updated.

Connettere Bot Agent a un dispositivo con un proxy alla pagina 1046
4. Set device credentials to for the Control Room to deploy bots on your device.

Set user device credentials alla pagina 1052
5. Switch to a different Control Room based on your automation requirements.

Switch Bot Agent to a different Control Room alla pagina 1045
6. When updates are available, you can update the Bot Agent to the latest version. You can enable one

of the following methods of updating Bot Agent:
• Aggiornamento automatico di Bot Agent alla pagina 1042
• Aggiornamento manuale del Bot Agent alla pagina 1043
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7. Verify the Bot Agent version and device connection under the Devices page in Control Room.
Dispositivi alla pagina 2628

Related tasks

Users can also perform the following tasks:
• Use the Bot Agent diagnostic utility to perform diagnostic checks on Bot Runner devices and to help in

resolution of Bot Agent connectivity challenges.
Esecuzione di controlli diagnostici Bot Agent alla pagina 1048

• Use the Bot Agent relevant logs to resolve issues.
Bot Agent log files alla pagina 2465

• Create and edit TaskBots
Creazione del primo bot alla pagina 1059 | Modifica di un bot alla pagina 2007

• Deploy bots on attended and unattended Bot Runners with or without Workload automation.
Run a bot alla pagina 1994 | Programmare un bot alla pagina 2616 | Esegui bot con coda alla pagina 2807

• Manage different bots and packages using Bot Store, Bot Insight, and Automation 360 IQ Bot.
• Bot Store alla pagina 2944
• Utilizzo di Bot Insight alla pagina 2973
• Automation 360 IQ Bot alla pagina 2472

• Perform other activities such as updating user profile.
Modifica profilo alla pagina 1002

Nota:  For additional information about the Bot Agent, see Automation Anywhere Certification (A-People login
required)

Bot Agent communication with Control Room
Bot Agent uses various channels to communicate with the Control Room. Relevant data is transferred
directly and indirectly using communication channels such as loop-back interface, browser plug-in, and
WebSocket connection.

© 2023 Automation Anywhere. All rights reserved.     1037

https://university.automationanywhere.com/certification/rpa-certification
https://university.automationanywhere.com/certification/rpa-certification


    Automation Anywhere - Installazione e aggiornamento Automation 360

© 2023 Automation Anywhere. All rights reserved.     1038



    Automation Anywhere - Installazione e aggiornamento Automation 360

Browser to loop-back interface

The browser-to-loop-back-interface channel is used during initial Bot Agent device registration and post-
registration to check the current connection status to the Control Room. The loop-back interface uses HTTP
unencrypted connection.
The following initial registration data is transferred over this channel:
• Control Room user token. This is accessible through developer tools on the browser.
• URL Control Room
• Proxy metadata, such as device ID, whether the proxy is configured or not, and whether it uses

authentication or not.

The following connection status data is transferred over this channel:
• ID del dispositivo
• URL Control Room
• Installation type, such as system-level or user-level
• Proxy metadata, such as device ID, whether the proxy is configured or not, and whether it uses

authentication or not.

Browser to Control Room

The browser-to-Control Room channel is used by the browser to connect to the Control Room. The data
transferred over this channel includes all Control Room web data. The browser uses HTTPS encrypted
connection.

Plug-in to Bot Agent named pipe

The plug-in to the Bot Agent named pipe channel is used to fetch current logged-in username and
credentials if an authenticated proxy is to be obtained for the browser. The plug-in channel is protected by
user permissions.

Bot Agent to Control Room WebSocket

The Bot Agent-to-Control Room WebSocket channel is used for all command and data transfer between the
Bot Agent and Control Room. Data transferred over this channel includes requests from the Bot Agent to
the Control Room, bot code transfer, password data, Control Room-to-Bot Agent requests. Password data is
payload-encrypted, with the device public key in addition to the TLS encryption of the channel.

Installazione di Bot Agent e registrazione del dispositivo
Install Bot Agent on your local device and connect it to Control Room. In order to run bots on that local
device, ensure that you add it to the list of enabled host devices.
• To install the Bot Agent, the Windows installer policy must be enabled for your local device.
• The read, write, and execute permissions must be enabled for the Bot Agent folders on your local

device.
• Ensure that the local device system date and time are in sync with the current date and time so that

the device registration is successful.
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Credential requirements alla pagina 853
La versione di Bot Agent disponibile per il download è la più recente e compatibile con la versione della
Control Room utilizzata.

Nota:
• You can now install the Bot Agent on a device with an existing Enterprise 11 client.

• A Bot Creator can log in and access both Automation 360 and Enterprise 11 client to create bots.
• Attended Bot Runners can run bots from both Automation 360 and Enterprise 11 Control Room

instances.
• Unattended Bot Runners can deploy bots by using the run and schedule permission on the same

device.

• Non puoi eseguire bots da Enterprise 11 e Automation 360 allo stesso tempo.
• You cannot install a Bot Agent on a device with an existing Enterprise 10 client.
• When the Bot Agent is installed on a device where Enterprise 11 client is also installed and then you

uninstall the client, you might face login issues with the device. Therefore, you must uninstall and re-
install the Bot Agent on the device.

1. Use a supported browser to log into Control Room through your Automation Anywhere URL.
2. Installa Bot Agent e aggiungi un dispositivo locale scegliendo una delle seguenti opzioni:

• From the menu on the left, click the device icon to connect a local device.
• Vai alla pagina Dispositivi e fai clic sull'icona Connetti dispositivo locale situata in alto a destra

nell'elenco Dispositivi.

3. Fai clic su Esegui la connessione al computer.
Il file di installazione di Bot Agent viene scaricato.

4. Segui i passaggi descritti nella procedura guidata.
Accesso proxy autenticato: Se l'accesso del dispositivo a Internet è controllato tramite un server
proxy di autenticazione, viene richiesto di fornire i dettagli di autenticazione del server proxy. Queste
credenziali sono necessarie per consentire al dispositivo di comunicare con la Control Room.
Per abilitare il proxy autenticato, registra il dispositivo tramite un browser Google Chrome con
l'estensione Automation 360 Chrome abilitata.

Nota:  The Chrome and Edge extensions are installed for Google Chrome and Microsoft Edge
Enterprise browser users, respectively, even if the device is offline. The extension is downloaded with
the Bot Agent MSI installer file.

5. Seleziona un'opzione per installare Bot Agent a livello di sistema o di utente.
• Per installare a livello di sistema, seleziona Qualsiasi utente di questo computer (tutti gli

utenti)
Tutti gli utenti del dispositivo potranno utilizzare questo Bot Agent. Tuttavia, tutti gli utenti che
installano il Bot Agent devono disporre dei privilegi di amministratore.

• Per installare a livello di utente, seleziona Solo per (nome utente).
Il Bot Agent sarà disponibile solo per il singolo utente.
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6. Inserisci quanto segue nella schermata Informazioni aggiuntive:
• Nickname del dispositivo (facoltativo)
• Tipo di dispositivo (singolo utente o più utenti)

Nota:  In caso di un dispositivo per più utenti, inserisci il numero di sessioni simultanee che
saranno consentite. Sono supportate almeno due sessioni simultanee.

7. Fai clic su Fine.
• Bot Agent viene installato nella posizione predefinita C:\Program Files\Automation

 Anywhere\Bot Agent.
• The Bot Agent is registered as a Windows service: Automation Anywhere Bot Agent Service.
• Al menu Start di Windows e sul desktop viene aggiunto un collegamento rapido per accedere a

AARI Assistant.
• I file del Java Runtime Environment (JRE) vengono installati con Bot Agent nella cartella di

installazione Bot Agent: C:\Program Files\Automation Anywhere\Bot Agent\jre.

8. Imposta le credenziali del dispositivo utente in modo che il dispositivo possa eseguire bots.
9. Aggiorna la pagina Dispositivi e verifica che il dispositivo locale sia stato aggiunto.

È possibile identificare i dispositivi in base al loro indirizzo IP e nome host.

Nota:  Dopo aver rimosso un dispositivo, attendi 35 secondi per registrarlo nuovamente.

Risoluzione dei problemi:
• se riscontri problemi durante la registrazione del dispositivo, consulta Automation 360: Error while

registering device - An unexpected problem occurred (A-People login required).
• If the Bot Agent service is paused and does not start after installation, see Automation 360 Error: Device

is disconnected or needs upgrade (A-People login required).
• Se stai usando la versione 94 o successiva del browser Google Chrome e se hai problemi a registrare il

dispositivo in una Control Room On-Premises, ti consigliamo di configurare la Control Room per HTTPS
invece di HTTP. In alternativa, usa Microsoft Internet Explorer o Mozilla Firefox per registrare il tuo
dispositivo.
If you face any issues adding a new device, see Unable to Add New Device (A-people login required).

• Se rimuovi manualmente l'estensione Google Chrome, il criterio Google Chrome esistente non consente
di aggiungere l'estensione (online oppure offline) anche dopo aver reinstallato Bot Agent. Ti consigliamo
di non rimuovere l'estensione. Tuttavia, se rimuovi manualmente l'estensione, esegui una delle seguenti
operazioni:
• Vai allo store estensione Google Chrome per aggiungere l'estensione online.

Automation 360 extension for Chrome
• Trascina il file ChromeExtension.crx (C:\Program Files\Automation Anywhere\Bot

 Agent\AABrowserAgent) nella scheda dell'estensione Google Chrome (menu con tre puntini
verticali in alto a destra > Impostazioni > Estensioni).

Guarda il seguente video su come installare Bot Agent su Automation 360:

Facoltativamente, Modifica profilo alla pagina 1002.
If your device is set with a proxy, see the tasks that apply to your proxy settings, Connettere Bot Agent a un
dispositivo con un proxy alla pagina 1046.
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Concetti correlati
About device pools alla pagina 2635
Device pools are a logical grouping of devices or similar unattended Bot Runner machines on which you
can run your workload management automations or scheduled unattended automations. For example, you
can group the devices (system-wide type) of a specific department or unit and create a device pool.
Attività correlate
Crea pool di dispositivi alla pagina 2636
Create a device pool with a unique name and add Unattended Bot Runners to the device pool.
Set user device credentials alla pagina 1052
Per abilitare un dispositivo per l'esecuzione di bots, imposta le credenziali del dispositivo locale.

Aggiornamento automatico di Bot Agent
Un amministratore Control Room può scegliere di aggiornare automaticamente il Bot Agent a una versione
successiva utilizzando la funzionalità di aggiornamento automatico. Questo riduce il tempo di inattività
perché a ogni utente non è richiesto di accedere a Control Room per aggiornare il Bot Agent installato sul
dispositivo utente.
Ensure that you are logged in to the  as the administrator.
Bot Agent si aggiornerà automaticamente in base a quanto segue:
• Tutti gli utenti e i dispositivi sono connessi a Control Room.
• La distribuzione Automation 360 utilizzata.

Nota:  Automatic update of the Bot Agent is available only for version 21.0 or later. L'impostazione
di aggiornamento automatico è abilitata per impostazione predefinita per gli utenti Automation 360
Cloud e Community Edition. Per distribuzioni On-Premises, l'impostazione di aggiornamento manuale è
abilitata di default.

To manually update Bot Agent, see Aggiornamento manuale del Bot Agent alla pagina 1043.
1. Accedi a Amministrazione > Impostazioni > Dispositivi.
2. Seleziona le impostazioni Software bot-agent.
3. Click the Edit icon. ( )
4. For automatic updates of the Bot Agent, you can choose either all updates (required and optional) or

only the required updates.
Opzione Descrizione

Auto update optional and mandatory Automatically update the Bot Agent for both
required and optional updates.
During the update, new bot deployments on the
Bot Runner user devices are queued.

Auto update mandatory updates only Automatically update the Bot Agent only for
required updates.
During the update, new bot deployments on the
Bot Runner user devices are queued.

Nota:  To set manually update the Bot Agent, choose Disable auto updates option.

5. Opzionale: Update the Bot Agent from a local drive alla pagina 1043.
6. Fai clic su Salva modifiche.
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Verificare la versione Bot Agent e la connessione del dispositivo alla pagina I miei dispositivi della
Control Room.
Attività correlate
Aggiornamento manuale del Bot Agent alla pagina 1043
The Bot Agent is a lightweight application with which you can run bots on your device. You can update the
Bot Agent when a new version becomes available.
Riferimenti correlati
Dispositivi alla pagina 2628
Il dispositivo è una macchina attraverso la quale un utente si connette alla Control Room per creare o
eseguire bots. Manage devices that are registered to the Control Room through the Devices page located
in the Manage tab.
Compatibilità di Bot Agent alla pagina 1025
Prima di installare Bot Agent, assicurati che sia compatibile con l'hardware e il software del tuo ambiente.

Update the Bot Agent from a local drive
As a Control Room administrator, you can download the Bot Agent installation file to a local machine and
update the Bot Agent from the local drive.
Ensure that the Bot Agent installation file is downloaded to the local machine.

Importante:  This functionality is implemented in v.26 and can be used from v.27. That is, after you
update your Bot Agent to v.26, future updates can be performed from the local drive.

Update the Bot Agent on several devices by providing the local file path to the installation file.
1. Navigate to Administration > Settings > Devices and click the Edit icon ( ).
2. Go to the Bot-agent software settings.
3. Click the Edit icon. ( )
4. In the Bot agent installation section, select the Update bot agent from local drive option.

When the Update bot agent from local drive option is enabled, the device checks for the
installation file in the local drive and use it to update the Bot Agent.

Nota:  If an installation file is not available in the local drive or not compatible with Control Room, the
Bot Agent will be updated with the latest version from the Control Room.

5. Enter the file path to the Bot Agent installation file in your local drive.
Ad esempio: C:\Temp\AutomationAnywhereBotAgent.exe or \\network-share-name
\foldername1\AutomationAnywhereBotAgent.exe

6. Fai clic su Salva modifiche.

Aggiornamento manuale del Bot Agent
The Bot Agent is a lightweight application with which you can run bots on your device. You can update the
Bot Agent when a new version becomes available.
• Per installare il Bot Agent, è necessario abilitare la policy Windows Installer per il dispositivo dell'utente.
• Le autorizzazioni di lettura, scrittura ed esecuzione devono essere abilitate per le cartelle Bot Agent sul

dispositivo dell'utente.

La versione di Bot Agent disponibile per il download è la più recente e compatibile con la versione della
Control Room utilizzata. Consulta Compatibilità di Bot Agent alla pagina 1025.
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Nota:  Puoi eseguire l'aggiornamento alla versione più aggiornata di Bot Agent per utilizzare le nuove
funzionalità disponibili nell'ultima versione di Automation 360. However, some Bot Agent versions are
optional to update and does not affect your existing bots. Consulta Compatibilità di Bot Agent alla pagina
1025.

• Update the Bot Agent on connected host devices
a) Log in to the Control Room by using your Automation Anywhere URL.
b) Navigate to Manage > Devices.

Nella pagina Dispositivi, lo stato del dispositivo indica se Bot Agent richiede un aggiornamento. Il
colore della freccia sull'icona del dispositivo indica lo stato:
• Red: Update required
• Blue: Update available but not required
• Green: Current version; no update required

c) To update the Bot Agent on devices, select the devices for which you want the Bot Agent to be
updated and, at the top-right corner of the devices table, click the Update checked items icon
( ).
The Status for the devices changes to indicate the progress of the update. After the update is
complete, the Status will be changed to Connected.

Nota:  Puoi anche aggiornare un singolo dispositivo con operazioni a livello di riga.

Video: See the following video on updating the Bot Agent on connected host devices:

• Update the Bot Agent on a locally connected device or a remote device using the local
device option
You can update the Bot Agent on a locally connected device or a remote device without manually
downloading and installing the Bot Agent.
a) On the home screen, at the bottom-left corner, click the Local device icon ( ).
b) In the Bot running device window, click Update now.

The Status for the devices changes to indicate the progress of the update. After the update is
complete, the Status changes to Connected.

Video: See the following video on how to update the Bot Agent on a locally connected device:

Video: See the following video on how to update the Bot Agent on a remote device using the local
device option:
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• Update Bot Agent on the locally connected device using the connect local device option
You can update the Bot Agent on your locally connected device by manually downloading and installing
the Bot Agent.
a) From the Devices page, click the Connect local device icon ( ) at the top-right corner of the

devices table.
b) Fai clic su Esegui la connessione al computer.
c) Fai clic sul collegamento Scarica manualmente la versione più recente.
d) After the AutomationAnywhereBotAgent.exe is downloaded, install the Bot Agent and follow

the instructions on the installation wizard to complete the installation.
e) After the Bot Agent installation is complete, go back to Automation 360 Control Room and click

Next.
f) Follow the instructions on the screen to complete the update.

Video: See the following video on how to update the Bot Agent on the locally connected device using
the connect local device option:

Viene visualizzato il seguente messaggio: Connesso al computer.L'agente bot locale è stato
installato e configurato correttamente.

Se viene visualizzato il seguente messaggio: Il dispositivo è disconnesso o deve essere
aggiornato, vedere Error: Device is disconnected or needs upgrade (A-People login required)

Verificare la versione di Bot Agent e la connessione del dispositivo alla pagina Dispositivi della Control
Room.
Attività correlate
Aggiornamento automatico di Bot Agent alla pagina 1042
Un amministratore Control Room può scegliere di aggiornare automaticamente il Bot Agent a una versione
successiva utilizzando la funzionalità di aggiornamento automatico. Questo riduce il tempo di inattività
perché a ogni utente non è richiesto di accedere a Control Room per aggiornare il Bot Agent installato sul
dispositivo utente.
Riferimenti correlati
Dispositivi alla pagina 2628
Il dispositivo è una macchina attraverso la quale un utente si connette alla Control Room per creare o
eseguire bots. Manage devices that are registered to the Control Room through the Devices page located
in the Manage tab.
Compatibilità di Bot Agent alla pagina 1025
Prima di installare Bot Agent, assicurati che sia compatibile con l'hardware e il software del tuo ambiente.

Switch Bot Agent to a different Control Room
Switch the Bot Agent on a registered device to work with a different Control Room manually when you
work on automations using different environments.
Ensure that you have the start, stop, and pause permissions to access and edit the Windows services.
Perform this task to manually associate your device with a different Control Room in the following
scenarios:
• When the Control Room is on a different release version.
• When the setting to switch devices is not enabled in the Control Room.

1. Stop the Bot Agent service from the local Windows Task Manager.
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2. Navigate to the following folder: C:\Windows\System32\config\systemprofile\AppData
\Local\AutomationAnywhere

3. Opzionale: Delete the registration.properties file.

Nota:  This is only required if you want to register the device in a different Control
Room environment. To view the Control Room where the device is registered, open the
Registration.properties file and check the value for the Control Room URL.

4. Delete all .db files.
For example, AA-DB.mv.db file.

5. Accedi a Control Room.
6. Navigate to Devices > My devices.
7. Click the Add local device icon.
8. Download and install the latest Bot Agent.
9. Return to the Devices page in the Control Room from the updated device to check the device status.

The registration.properties file is not generated immediately after the Bot Agent
installation. It is generated only when a user accesses a Control Room URL from that
device. If the device registration is successful, the machine is shown as Connected and the
registration.properties file is created at the specified location on the Bot Runner machine.

10. Navigate to the C:\Windows\System32\config\systemprofile\AppData\Local
\AutomationAnywhere folder to ensure that the registration.properties file is present and
verify the Bot Agent update.

Attività correlate
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039
Install Bot Agent on your local device and connect it to Control Room. In order to run bots on that local
device, ensure that you add it to the list of enabled host devices.
Commutare la registrazione del dispositivo tra istanze di Control Room alla pagina 2734
Configura le impostazioni del dispositivo in Control Room per consentire ai dispositivi monoutente di
passare facilmente da un'istanza all'altra di Control Room per eseguire bots in più ambienti. Questa
opzione consente di registrare Bot Agent su più istanze di Control Room e passare a un'altra istanza senza
reinstallare Bot Agent.

Connettere Bot Agent a un dispositivo con un proxy
Quando si installa un Bot Agent, le impostazioni proxy del dispositivo vengono importate durante
il processo di installazione. Tuttavia, se le impostazioni del proxy non vengono importate durante
l'installazione, è possibile aggiornare i dettagli della configurazione del proxy manualmente.

Nota:  Your device proxy settings for authenticated proxy can be set during the Bot Agent registration
process and can be updated via the Bot Agent diagnostic utility. The same credentials will be used for all
users on the device.

In genere, quando modifichi le impostazioni del proxy, sia che tu abbia aggiunto un proxy o modificato le
credenziali al proxy di autenticazione, Bot Agent richiede le nuove credenziali.
Puoi utilizzare due metodi per aggiungere o aggiornare manualmente le credenziali del proxy.
• Using PSExec -sid command.
• Using netsh winhttp command.
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Puoi eseguire queste operazioni prima o dopo l'installazione di Bot Agent.
1. Per aggiungere o aggiornare le credenziali del proxy, utilizza uno dei seguenti metodi.

• Using PSExec -sid command.
a. Scarica PSTools.

PsExec

b. Estrai i file dal file zip scaricato.
c. Apri il prompt dei comandi di Microsoft in modalità amministratore.
d. Passa alla directory in cui sono stati estratti i file PSTools.
e. Esegui il comando seguente:

.\psexec -i -s -d cmd

f. Nella nuova finestra del prompt dei comandi, esegui il comando seguente:

whoami

The system returns the following:

nt authority\system

g. Esegui il comando seguente:

inetcpl.cpl

h. In Proprietà Internet, accedi a Connessioni > Impostazioni LAN.
i. Seleziona l'opzione Usa script di configurazione automatica.
j. Fornisci l'indirizzo per il file di autoconfigurazione proxy (PAC).

Ad esempio: http://localhost:888/proxy.pac.
k. Fai clic su OK.

• Using netsh winhttp command.
a. Apri il prompt dei comandi di Microsoft in modalità amministratore.
b. Elenca lo stato del proxy eseguendo il comando:

netsh winhttp show proxy

c. If the command returns Direct access, then run the command:
netsh winhttp import proxy source = ie

Se le impostazioni proxy sono configurate, il comando restituisce l'indirizzo del server proxy.
Osserva il seguente esempio:

Current WinHTTP proxy settings:
Proxy server(s): 123.0.0.4:1234
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Bypass List    : (none)

You do not have to import the settings.

Nota:  We recommend you import proxy settings using Bot Agent installer because of limitations to
importing PAC file using the netsh winhttp import proxy source = ie command.

2. Riavvia il servizio Bot Agent da Servizi Windows.
3. Apri un browser Google Chrome con l'estensione Automation Anywhere abilitata.
4. Disconnettiti e accedi nuovamente alla Control Room.

Se richiesto, fornisci le credenziali del proxy.
5. Dalla Control Room, controlla lo stato del dispositivo e verifica che sia connesso.

Riferimenti correlati
Automation 360 Bot Runner device requirements alla pagina 829
Review the machine hardware specifications, operating system versions, and browser types supported
for creating and running bots on a device. The same requirements are also valid for Automation 360
Community Edition.
Compatibilità di Bot Agent alla pagina 1025
Prima di installare Bot Agent, assicurati che sia compatibile con l'hardware e il software del tuo ambiente.
Add Automation 360 Cloud URLs to trusted list alla pagina 831
To ensure secure access to Automation 360 cloud services, add the URL specific to the service to the safe
recipients or trusted list.
Add Automation 360 On-Premises URLs to trusted list alla pagina 974
To ensure secure access to Automation 360 online services for On-Premises deployment, add the URL
specific to the service to the safe recipients or trusted list.

Esecuzione di controlli diagnostici Bot Agent
Usa l'utilità di diagnostica Bot Agent per problemi di connettività tra il dispositivo Bot Runner e Control
Room. L'utilità facilita la diagnosi dei problemi fornendo soluzioni o suggerimenti per facilitare la risoluzione
dei problemi.
Assicurati che Bot Agent sia installato sul dispositivo utente.
1. Apri il prompt dei comandi di Windows.
2. Accedi al percorso di installazione di Bot Agent.

• Il percorso predefinito per Bot Agent installato a livello di sistema è C:\Program Files
\Automation Anywhere\Bot Agent.

• Il percorso predefinito per Bot Agent installato a livello di utente locale è %USERPROFILE%
\AppData\Local\Programs\Automation Anywhere\Bot Agent.
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3. Inserisci AADiagnosticUtility.exe per eseguire l'utilità di diagnostica Bot Agent.
Sono visualizzate diverse opzioni per eseguire il controllo diagnostico con le relative descrizioni.

Opzione Descrizione

-checkDownloadError <CR_URL> Verifica la presenza di errori di download delle
dipendenze bot se la distribuzione di bot non
riesce.

Nota:  I messaggi di errore sono conservati
nella memoria del dispositivo e vengono rimossi
quando il servizio Bot Agent viene riavviato.

Usa questa opzione quando Bot Runner è
collegato alla Control Room ma le automazioni
non vanno a buon fine perché i pacchetti
dipendenti non vengono scaricati sul dispositivo
Bot Runner. In questo caso, l'utilità fornisce
suggerimenti per ulteriori diagnosi.

-checkProxy <CR_URL> Controlla le impostazioni proxy sul dispositivo.
Quando iBot Runner non è in grado di
connettersi alla Control Room, utilizza questa
opzione per verificare se un proxy è disponibile o
configurato per il Bot Agent da utilizzare.
You are also provided the option to import proxy
settings using the importProxy option.

Nota:  Your device proxy settings for
authenticated proxy can be set during the Bot
Agent registration process and can be updated
through the Bot Agent diagnostic utility. The
same credentials are used for all users on the
device.

-checkWSError <CR_URL> Verifica la connettività WebSocket e gli errori.

Nota:  I messaggi di errore sono conservati
nella memoria del dispositivo e vengono rimossi
quando il servizio Bot Agent viene riavviato dalla
scheda Servizi di Gestione attività di Windows.

Quando un dispositivo Bot Runner non è in
grado di connettersi alla Control Room a causa
di errori di connessione WebSocket, questa
opzione indica i possibili motivi per ulteriori
indagini.
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Opzione Descrizione

-collectLogs Riduci i tempi di raccolta delle informazioni
relative ai problemi grazie all'acquisizione di più
registri dal dispositivo Bot Runner.
Usa questa opzione per acquisire e salvare il
gestore di nodi del giorno corrente, l'utilità di
avvio bot e i registri del visualizzatore di eventi
per il debug e la risoluzione dei problemi in una
cartella zip sul dispositivo su cui viene eseguita
l'utilità.
• Per Bot Agent installato a livello di

sistema, i registri sono salvati in C:
\ProgramData\AutomationAnywhere
\BotRunner\Logs
\bot_agent_logs_<datetimestamp>.zip

• Per Bot Agent installato a livello di
utente locale, i registri sono salvati
in %USERPROFILE%\AppData
\Local\AutomationAnywhere
\BotRunner\Logs
\bot_agent_logs_<datetimestamp>.zip

Nota:
• Per acquisire i registri di Windows per

gli eventi di sicurezza, esegui l'utilità
con privilegi elevati (esegui come
amministratore).
Se si esegue l'utilità senza privilegi elevati,
viene visualizzato il seguente errore:
Errore: Impossibile acquisire
 security_event_viewer_<date>.evtx

• Per risparmiare spazio di archiviazione,
elimina il file dopo il debug.

-configProxy <CR_URL> Se necessario, controlla la configurazione del
proxy e configura le credenziali del proxy.
Quando il dispositivo Bot Runner non è in grado
di connettersi alla Control Room a causa di
credenziali mancanti per un server autenticato,
utilizza questa opzione per configurare le
credenziali del server proxy. Verifica che il
problema di connettività sia risolto accedendo
alla Control Room.
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Opzione Descrizione

-importProxy <CR_URL> Importa le impostazioni del proxy da un
dispositivo utente connesso al dispositivo utente
del sistema.

Nota:  Devi avere l'autorizzazione
dell'amministratore per importare le impostazioni
proxy.

Quando il dispositivo Bot Runner non è in grado
di connettersi alla Control Room a causa di
problemi con il server proxy, utilizza questa
opzione per importare le impostazioni proxy da
un utente connesso all'utente di sistema per Bot
Agent.
Questa opzione fornisce informazioni su quanto
segue:
• Se il server proxy è autenticato o non è

autenticato.
• L'URL Control Room viene aggiunto all'elenco

dei destinatari sicuri nel server proxy.
• Le connessioni WebSocket sono consentite

come parte della configurazione del proxy.

-importSSLCertificate
 path_to_ssl_certificate

Se necessario, importa un certificato SSL
nell'archivio delle credenziali Java.

Nota:  Devi avere l'autorizzazione
dell'amministratore per importare il certificato
SSL.

Quando il dispositivo Bot Runner non è in
grado di connettersi alla rete Control Room
a causa di un certificato SSL non valido, usa
questa opzione per importare il certificato
SSL. You must ensure a valid certificate file
is available in the file location specified in the
importSSLCertificatepath_to_ssl_certificate
option.
È necessario riavviare il servizio Automation
Anywhere Bot Agent affinché il certificato
importato diventi effettivo.

-list Visualizza le distribuzioni di bot attive sui
dispositivi locali.
Usa questa opzione per controllare ed elencare
(bots) automazione in esecuzione.
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Opzione Descrizione

-ping <CR_URL> Controlla la connettività tra Control Room e i
dispositivi Bot Runner.
Usa questa opzione per controllare se un
dispositivo Bot Runner può eseguire il ping
(raggiungere) la Control Room.

-validateSSLCertificate
 <CR_URL>

Verifica la presenza di un certificato SSL valido e
visualizza se il certificato è valido o non valido.

Nota:  Devi avere l'autorizzazione di lettura per
eseguire questo controllo.

Quando il dispositivo Bot Runner non è in grado
di connettersi alla rete Control Room a causa di
un certificato SSL non valido, usa questa opzione
per controllare e vedere se il certificato SSL è
valido o non è valido. To resolve the issue, use
the importSSLCertificate option.

4. Inserisci la seguente opzione nel prompt dei comandi: <filepath>\AADiagnosticUtility.exe
 -<option> <CR_URL>
Ad esempio, per verificare gli errori di WebSocket, inserisci quanto segue nel prompt dei comandi:
AADiagnosticUtility.exe -checkWSError https://yourcrurl.com/
L'opzione restituisce il seguente risultato: Di recente questo dispositivo non ha
riscontrato errori WebSocket

Utilizza le altre opzioni per eseguire ulteriori controlli diagnostici.

Set user device credentials
Per abilitare un dispositivo per l'esecuzione di bots, imposta le credenziali del dispositivo locale.
The Bot Agent is a lightweight application that enables you to run bots on your device by connecting the
device to the Control Room. To run bots on a local machine, install the Bot Agent and add the local device
to the list of enabled host devices. Aggiungi il dispositivo locale prima di modificare le credenziali. Consulta
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039.
Per gli utenti di Community Edition, il tuo profilo contiene un solo set di credenziali alla volta. These
credentials are applied to any of your registered devices you select to run your bots. Assicurati che ogni
dispositivo utilizzato accetti le credenziali del tuo profilo.
Automation 360 Cloud users have the option to apply different credentials to registered devices.
1. Nel pannello Control Room fai clic sul tuo nome utente e seleziona Le mie impostazioni.
2. In My Settings page, navigate to Devices > Credentials section to update the Username and

Password for the device.
Device login credentials are required to run a bot from this device.

Nota:  Automation 360 does not validate the device login credentials until you run a bot.

If your username is part of a domain, include the domain within the format domain\username.
Typically, home users are not part of a domain, unless they are specifically configured.

3. Salva le modifiche.

© 2023 Automation Anywhere. All rights reserved.     1052



    Automation Anywhere - Installazione e aggiornamento Automation 360

Creazione del primo bot alla pagina 1059
Attività correlate
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039
Install Bot Agent on your local device and connect it to Control Room. In order to run bots on that local
device, ensure that you add it to the list of enabled host devices.

View and update Bot Agent device settings
View your local device details and update the bot running device settings. The local device is the one from
which you access the Bot Agent. The bot running device is the one on which the recorder will record your
automations and run the bots.
You must have the register device, view and manage all devices, attest device credentials, and edit devices
permissions to perform this task. Consulta Credential requirements alla pagina 853.
This task is performed by a user to select a local user or remote Bot Agent device to create and run bots.
1. In the Control Room, click your username and select the My settings link.
2. In the Devices > Bot running device section, click Edit.
3. Select a bot running device.
4. Salva le modifiche.

Nota:  To update the local device settings, click the device name link. This will open the Devices
page for your local device in view mode.

Concetti correlati
Manage device settings alla pagina 2727
Control Room administrator can configure the device settings to automatically set a user's default device
when that user logs into Control Room.

Bulk install Bot Agent on devices
Installing Bot Agent across multiple devices such as on-premises machines, virtual machines (VM), and
non-persistent virtual desktop infrastructure (VDI) is called Bulk install (or silent install). You must edit the
Bot Agent MSI file for bulk installation.
To perform the task, you must have a  administrator account with the required rights and permissions.
• Ensure that you have downloaded the MSI file from the Control Room and the parameters required to

install devices are available in the Bot Agent MSI file.

Nota:  If you are trying to download the MSI file for the first time, you must click Settings > Bot
agent bulk install > Edit > Save changes to generate a registration key and view the Download
installer for the MSI file. .

• Ensure that the Windows 10 Software Development Kit including Orca is installed on the device.
È possibile installare Orca da C:\Program Files (x86)\Windows Kits\10\bin
\10.0.18362.0\x86\Orca-x86_en-us.msi.
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Nota:  You can find a sample autoregistration.properties file at the end of the page for your
reference.

1. Utilizza il file AutomationAnywhereBotAgent.msi più recente, disponibile dalle seguenti posizioni:
• Scarica il file dalla Control Room (Amministratore >  Impostazioni > Installazione in blocco

dell'agente bot).
L'opzione di download è disponibile per le distribuzioni On-Premises e Cloud.

• Seleziona il file dall acartella <application filepath>\crui\asset. Ad esempio C:
\Program Files\Automation Anywhere\crui\asset

Questa opzione è disponibile solo per le distribuzioni On-Premises.

2. Modifica il file AutomationAnywhereBotAgent.msi utilizzando lo strumento Orca.
3. Fai clic sull'opzione Proprietà.
4. Immetti i valori appropriati per i seguenti parametri:

Parametro Descrizione

AA_CRURL Immetti l'istanza Control Room a cui desideri
connettere Bot Agent.

Nota:  Assicurati di non aggiungere
una barra rovesciata (/) alla fine
dell'URL Control Room. Ad esempio,
mycr.mydomain.com/.

AA_CRTOKEN Immetti il valore della chiave di registrazione
corrispondente per ogni Control Room.
La chiave di registrazione viene fornita
dall'amministratore Control Room.
Puoi configurare fino a 20 URL della Control
Room. Ensure that:
• You provide the corresponding

registration tokens under AA_CRTOKEN,
AA_CRTOKEN2 through AA_CRTOKEN20
for each configured Control Room URL.

• There is a one-to-one match between
CR_URL and CR_TOKEN.

• There is no skipping between CR_URL
and CR_TOKEN, and this is filled
consecutively.
Ad esempio, per configurare tre URL
della Control Room, è necessario
compilarli nel seguente ordine:
AA_CRURL, AA_CRURL2, AA_CRURL3.

Consulta Generate registration key to install Bot
Agent in bulk alla pagina 2764.
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Parametro Descrizione

AA_DELAY_REGISTRATION_UNTIL_LOGIN Enter True to delay the Bot Agent
registration to a Control Room until a user
logs in to that Control Room.
Se un utente accede a una qualsiasi delle
istanze della Control Room configurate dal
dispositivo in cui è installato è installato l'Bot
Agent, l'Bot Agent su tale dispositivo viene
automaticamente registrato con la Control
Room associata. If the logged-in Control
Room URL is not configured, then Bot Agent
is not registered with that Control Room.

AA_DEVICE_TYPE Immetti uno dei seguenti valori per il tipo di
dispositivo:
• SINGLE_USER
• MULTIPLE_USERS

Nota:  Ensure that you enter the values in
uppercase.

AA_LIFESPAN Immetti uno dei seguenti valori per un
dispositivo non persistente o persistente:
• TEMPORARY
• PERSISTENT

Nota:  Ensure that you enter the values in
uppercase when you install the Bot Agent.

AA_CONCURRENT_SESSIONS Immetti le sessioni simultanee consentite,
da 1 a 99. Il valore predefinito è 1.

Nota:  The concurrent sessions are
only applicable for multi-user devices
(AA_DEVICE_TYPE = Multiuser)
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Parametro Descrizione

AA_INSTALL_ONLY Scegli se desideri installare Bot Agent senza
effettuare la registrazione alla Control Room.
• Immetti True per installare senza

effettuare la registrazione dell'Bot Agent.

Nota:
The autoregistration.properties
file is created when AA_INSTALL_ONLY
is set to True. You can set
AA_INSTALL_ONLY to True only for
system-level installation.

• Immetti False per installare ed
effettuare la registrazione dell'Bot Agent.

AA_DEVICE_POOL_NAME Specify the device pool name. Il valore
predefinito è 0.

Nota:  Ensure that you use an existing
device pool.

5. Salva le modifiche.
6. Copia il file AutomationAnywhereBotAgent.msi nell'istanza VM (immagine dorata) in cui desideri

installare Bot Agent.
7. Esegui il file AutomationAnywhereBotAgent.msi.
8. Verifica che il Bot Agent sia installato sull'istanza VM e che il servizio Bot Agent non sia in esecuzione

nella scheda Servizi Gestione attività.

Nota:  An autoregistration.properties file will be generated at C:\Windows
\System32\config\systemprofile\AppData\Local\AutomationAnywhere.

Per distribuire Bot Agent su dispositivi temporanei o non persistenti, è necessario configurare le
impostazioni SysPrep e creare immagini della macchina sull'istanza VM.
9. Arresta l'istanza VM senza SysPrep dopo aver abilitato le impostazioni temporanee o non persistenti

del nome del computer per la VM.
Per avere un esempio di come utilizzare SysPrep su un'istanza EC2 AWS, consulta Use Sysprep to create
and install custom reusable Windows AMIs.

10. Crea le immagini della macchina sull'istanza VM come richiesto.
Per avere un esempio di come creare Amazon Machine Image (AMI) da un'istanza EC2 AWS, consulta
Create an AMI from an Amazon EC2 Instance.

Se Bot Agent viene registrato per errore nell'istanza della macchina virtuale, esegui queste operazioni per
ripristinare l'immagine della macchina:
1. Disinstalla Bot Agent dal Pannello di controllo di Windows dell'istanza VM.
2. Elimina tutti i file da C:\Windows\System32\config\systemprofile\AppData\Local

\AutomationAnywhere.
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3. Enter True for the AA_INSTALL_ONLY parameter in the AutomationAnywhereBotAgent.msi file
that you previously used to install the Bot Agent.

Sample autoregistration.properties file

url=http://ec2-myexampleCR.com
url2=URL2
url3=URL3
url4=URL4
token=eyJhbGciOiJSUzUxMiJ9.eyJjbGllbnRUeXBlIjoiQk9UX0FHRU5UX0FVVE9fUkVHSVNUUkFUSU9OIiwidGVuYW50VXVpZCI6ImI4ZjVmNDE0LWMzZDMtNGRhNy04NDljLWMxOGUwOGNiM2Q5ZCIsImlhdCI6MTY1NTg3NTgyMiwiZXhwIjoxOTcxMjM1ODIyLCJpc3MiOiJBdXRvbWF0aW9uQW55d2hlcmUiLCJuYW5vVGltZSI6NzMxMDYzMzkwNzQ5NX0.BA2bPiIECl9PE34BC1mj2iePLuTlSd8y8Fe1LtIkOKYrD8mR-
KVOnMeupDQF4IQ3oZbjpyk73vrLI2k0UeTVpvKuURbZhz8bPIBYer4zlzRjEB-9nOID8MtNRcpzlXgkQ27GEN2pOn4Xs_k198rPJEYHcTwaHRbQ8Mv5UF0eGd8_Q9sLgZB6jt1BhnzMNS3qwZBl1aG1xbOc7orlfyBfTGSvAxnlsRa3_fF7QeFKiw7EdfJDGsIVmIZ58-
IMzer-R8sxMnr7hSfi_aYDx8emyoH2XtFAQAYuXiw6vOXWa1o-TYDtPknIJsga6aAiFJ9-
w6ndJAov0JvTClmeyLQgBA
token2=t2
token3=t3
token4=t4
device_type=MULTIPLE_USERS
concurrent_sessions=4
lifespan=TEMPORARY
delay_registration_until_login=true

Verifica che i dispositivi vengano aggiunti nella pagina Dispositivi Control Room.
Attività correlate
Configure temporary devices alla pagina 2731
Configure your device settings to automatically delete a temporary device when the device is disconnected
from the Control Room after a certain time interval.
Generate registration key to install Bot Agent in bulk alla pagina 2764
The Control Room administrator can generate a registration key to install the Bot Agent on multiple devices
at a time in bulk.
Edit the Bot Agent installer file alla pagina 2765
Edit the Bot Agent MSI installer file to add the registration key and Control Room URL to remotely install
the Bot Agent on multiple devices.
Riferimenti correlati
Compatibilità di Bot Agent alla pagina 1025
Prima di installare Bot Agent, assicurati che sia compatibile con l'hardware e il software del tuo ambiente.
Dispositivi alla pagina 2628
Il dispositivo è una macchina attraverso la quale un utente si connette alla Control Room per creare o
eseguire bots. Manage devices that are registered to the Control Room through the Devices page located
in the Manage tab.

Bulk install Bot Agent using Microsoft Endpoint Configuration Manager
Install Bot Agent in bulk on multiple devices from a central location using the Microsoft Endpoint
Configuration Manager or System Center Configuration Manager (SCCM).
• Ensure that Microsoft SCCM is installed on two machines, first on a machine that hosts the Control

Room primary site and distribution server and then on a second machine that hosts the database server
to store and process all client-server communication and operations.
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• Ensure that the latest AutomationAnywhereBotAgent.msi file is downloaded from one of the
following locations based on your Control Room deployment:
• For On-Premises and Cloud: Administrator > Settings > Bot agent bulk install
• For On-Premises: <application filepath>\crui\asset folder

For example, C:\Program Files\Automation Anywhere\crui\asset.

1. Add parameters in the AutomationAnywhereBotAgent.msi file using the Orca tool.
For detailed steps, see Bulk install Bot Agent on devices alla pagina 1053.

2. Configure the Bot Agent application in SCCM.
a) Add general details, such as application name.

For example, Automation Anywhere Bot Agent Windows installer (*msi file).
b) Add content details, such as content location, settings for uninstalling, and deployment options.

Ad esempio:
• Content location: \\crserver\msibackup\
• Settings for content uninstalling: Same as install content
• Deployment options: Download content from distribution point and run locally

c) Provide the program commands required to install the application.
Ad esempio, msiexec /i "AutomationAnywhereBotAgent.msi"/q.

d) Provide the application detection method to determine whether the application is already installed
on a device.
The SSCM automatically detects and adds the clause for the msi file.

e) Provide user experience details, such as installation behavior (install for system or user),
logon requirement, installation visibility (interactive or hidden), and whether or not to enforce
configuration manager behavior.
Ad esempio:
• Installation behavior: Install for system
• Logon requirement: Whether or not a user is logged on
• Installation visibility: Nascosto

Per ulteriori informazioni, consulta Create and deploy an application with Configuration Manager.
3. Distribute the application on devices using the SCCM Distribution Point (DP).

To install the Bot Agent, configure the DP on the primary server on which the Control Room is
installed. It is important to ensure that after the application is created, it is distributed properly to DP
and it can be monitored in SCCM.
Per ulteriori informazioni, consulta Install and configure distribution points in Configuration Manager.

4. Use boundaries in SCCM to virtually partition the devices identified through domains, subnets, or a
range of IP addresses.
Boundaries help in segregating the DP for different applications and can be configured through the
hierarchy configuration section from the Administration option of SCCM.
Per ulteriori informazioni, consulta Define network locations as boundaries for Configuration Manager.

5. Right-click Automation Anywhere Bot Agent application to deploy the Bot Agent using the SCCM
Applications option.
Per ulteriori informazioni, consulta Deploy applications with Configuration Manager.

6. Verify that the devices are added on the Control Room Devices page.
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Attività correlate
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039
Install Bot Agent on your local device and connect it to Control Room. In order to run bots on that local
device, ensure that you add it to the list of enabled host devices.
Bulk install Bot Agent on devices alla pagina 1053
Installing Bot Agent across multiple devices such as on-premises machines, virtual machines (VM), and
non-persistent virtual desktop infrastructure (VDI) is called Bulk install (or silent install). You must edit the
Bot Agent MSI file for bulk installation.
Edit the Bot Agent installer file alla pagina 2765
Edit the Bot Agent MSI installer file to add the registration key and Control Room URL to remotely install
the Bot Agent on multiple devices.
Riferimenti correlati
Dispositivi alla pagina 2628
Il dispositivo è una macchina attraverso la quale un utente si connette alla Control Room per creare o
eseguire bots. Manage devices that are registered to the Control Room through the Devices page located
in the Manage tab.

Creazione del primo bot
Attieniti alla seguente procedura per creare il primo bot che stampa il messaggio Go be great!, la
versione Automation Anywhere di Hello World!
naming conventions: Keep the following considerations in mind when creating and naming :
• When creating a , ensure that your  name does not include the following special characters:

Slash (/) Asterisk (*) Comma (,)

Backslash (\) Less than sign (<) Left or right braces ({})

Question mark (?) Greater than sign (>) Left or right brackets ([])

Pipe (|) Double quotation marks (") Plus sign (+)

Percent sign (%) -- --
• Il nome del  deve essere unico. If a  with the same name exists in the same folder location to which

you have access in the public workspace, you cannot create or rename the  with this name in the
private workspace.

• Do not use  names that are reserved for the Windows operating system. The reserved  names are as
follows:

CON PRN AUX NUL COM1

COM2 COM3 COM4 COM5 COM6

COM7 COM8 COM9 LPT1 LPT2

LPT3 LPT4 LPT5 LPT6 LPT7

LPT8 LPT9 -- -- --
• Ensure that a  name does not end with a period (.) or space.
• For more information about file naming, see Microsoft guidelines.

Questa attività viene eseguita dall'utente che desidera creare e distribuire . Devi disporre dei diritti e delle
autorizzazioni necessarie per completare questa attività, nonché dell'autorizzazione per accedere alla  come
utente con licenza.
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Nota:  questi passaggi descrivono il flusso di lavoro guidato per gli utenti che eseguono l'operazione la
prima volta. Il flusso di lavoro guidato viene visualizzato solo la prima volta che esegui questi passaggi.

1. Accedi alla tua istanza di Automation Anywhere Control Room.
2. Create a new bot:

a) Nel pannello di sinistra, fai clic su Automazione.
b) Fai clic su Crea nuovo > Bot.
c) In the Create Task Bot window, enter the bot name.
d) Accept the default folder location: \Bots\

To change the default bot storage location, click Choose and follow the prompts.
e) Fai clic su Crea e modifica.

3. Inserisci una Finestra di messaggio action.
a) Fai clic su Azioni.
b) Search for the Message Box package.

Fai clic nella casella di ricerca Azioni e digita la parola messaggio. Fai clic sulla freccia per
espandere le opzioni Message Box.

c) Fai doppio clic o trascina l'action Finestra di messaggio su Bot editor (spazio aperto a destra).

4. Nella finestra di dialogo a destra, specificare le condizioni per l'action Finestra di messaggio.
a) Nel campo Inserisci il titolo della finestra di messaggio, immetti Il mio primo bot!.
b) Nel campo Inserisci il messaggio da visualizzare, immetti Go be great!.
c) Accetta i valori predefiniti nel campo Barra di scorrimento dopo le linee e della casella di

controllo Chiudi finestra di messaggio dopo.

5. Fai clic su Salva.
Il tuo bot è pronto per l'esecuzione.
Puoi visualizzare il tempo impiegato per creare un bot navigando in Automazione > Home > Le
mie metriche. La tabella TaskBot attivi mostra il tempo richiesto per creare ogni bot. Quando un
bot viene modificato, la tabella mostra il tempo totale impiegato sul bot.
Ad esempio, se impieghi 10 minuti per creare e salvare un file bot, nella tabella TaskBot attivi viene
visualizzato 10 minuti. Se impieghi altri 5 minuti per modificare lo stesso bot, nella tabella TaskBot
attivi viene visualizzato un tempo totale di 15 minuti.
Analogamente, il campo Tempo medio impiegato per creare un TaskBot nella pagina Le mie
metriche mostra il tempo medio impiegato da tutti gli utenti per tutti i bots.
For example, if user 1 spends 120 minutes on Bot A, user 2 spends 2 minutes on Bot B, and user 3
spends 4 minutes on Bot C, the average time is calculated as (120+2+4)/3 = 42 minutes.
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6. Fai clic sulle opzioni dell'Bot editor per visualizzare e modificare i bots:
Si trovano nella parte superiore dell'Bot editor.

Nota:  È possibile utilizzare la casella di ricerca nella visualizzazione Flusso, Elenco o Doppia per
cercare testo, variabili o actions in un bot. Questa caratteristica può essere utile quando si visualizza o
si modifica un bot con righe di codice più lunghe.

• Flusso: Displays actions used in an automation as a flow diagram (Default)

Nota:  The Flow view is not available when you create or edit a bot and the bot exceeds 500 lines
of code. Utilizza l'opzione Mostra vista elenco per passare alla visualizzazione dell'elenco.

• Elenco: Displays the actions used in an automation as a list

Nota:  Trascina l'actions selezionata all'interno della logica dell'attività.

• Doppio: Displays the actions used in an automation from both Flow and List view aspects
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7. Esegui il bot dal tuo dispositivo.
Consulta Run your first bot alla pagina 1062.

Run your first bot
Run a bot from the same device that you used to create the bot.
Log in to your instance of the Automation Anywhere Control Room, and complete these steps:.
1. Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039
2. Set user device credentials alla pagina 1052
3. Creazione del primo bot alla pagina 1059

These steps describe the guided workflow for first-time users. Il flusso di lavoro guidato viene visualizzato
solo la prima volta che esegui questi passaggi.
You can run a bot from the following devices:
• The same device you are using to log in to the Control Room.
• Another device you registered that has the same login credentials as the machine you are using to log

in to your Community Control Room or a device with defined credentials in the Control Room.

Nota:  Windows NT LAN Manager (NTLM) is a challenge or response authentication method that enables
clients to provide their user name and password as encrypted credentials or plain text. Use Google Chrome
browser to enable the Automation Anywhere extension and capture the proxy information. After the proxy
information is captured, you can use any browser to run a bot in Automation 360.

1. Locate and select your bot.
From your Control Room dashboard left panel, select Automation. Viene visualizzato un elenco di bot
e moduli disponibili.

2. Select the bot to run.
From the Files and folders table, mouse over the ellipsis (three stacked dots) to the right of your
bot's name.
The Edit TaskBot panel appears.
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3. Click the Run Task bot icon.
The Run bot now window opens. In the Task Bots table, your bot is selected to run.

4. Fai clic su Avanti.
The Device tab opens with a table of one or more registered devices.

5. If your device is not already selected, select your device to run the bot, and click the right arrow.
6. Click Run bot now.

Control Room uses the credentials in your profile to log in to the device you selected and runs the bot.
The In progress activity window opens with the status of the running bot. When the bot is done, it
disappears from this window.

7. Click Historical to see if your bot ran successfully.
Watch the following video on how to run your first bot in the Community Edition:

Build bots using variables, actions, and the Universal Recorder. Consulta Get started building bots alla pagina
2049.

Aggiornamento alla versione di Automation 360 più recente
Se stai già utilizzando Automation 360 On-Premises, puoi aggiornare alla versione più recente di
Automation 360.
• Prima di ogni aggiornamento della versione, assicurati di fare il backup del database, dell'archivio e dei

file di configurazione dell'installazione.
• Assicurati di essere su una delle tre versioni precedenti all'ultima (su una versione n-3, dove n si

riferisce alla versione più recente).
Ad esempio, per aggiornare a Automation 360 v.21, devi essere sulla versione v.20, v.19 o v.18.
Tuttavia, per aggiornare da v.15 a Automation 360 v.21, devi prima aggiornare alla v.18 e poi
aggiornare a Automation 360 v.21. Nel secondo scenario, assicurati di eseguire il backup dei dati di v.15
prima di aggiornare alla v.18 e poi il backup dei dati di v.18 prima di aggiornare alla v.21.

Importante:
• You must perform the following steps before you upgrade to the latest version of Automation 360:

• Ensure you reconfigure the settings for log4j2.xml files after the installation because when you
upgrade, the previous settings set at log level in log4j2 change back to default.

• Configure the SSL settings (certificates) every time you upgrade.

• Quando si aggiorna da una versione di Automation 360 precedente a una versione n-3 alla versione più
recente, è possibile che venga visualizzato un messaggio di errore Open Distro Elasticsearch. Prima di
eseguire l'aggiornamento, elimina i vari indici application_log da Elasticsearch, per liberare spazio su
disco per l'aggiornamento.
Per informazioni dettagliate sul limite degli indici Elasticsearch, vedi Cluster-level shard allocation and
routing settings.

• Prima di aggiornare da Automation 360 On-Premises v.22 all'ultima versione, vedi A360 | Upgrading to
A360.23, A360.24, A360.25 from A360.22 (A-People login required)
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• When you update to Automation 360 v.25 from an earlier release, an error might occur when the
database server includes the instance name. In such a scenario, remove the instance name in the
database server and continue with the installation.
For information on removing the instance name from the database server, see Error parsing the SQL
instance name while upgrading to Automation 360 v.25 (A-People login required).

1. Accedi al sito di supporto Automation Anywhere per scaricare la versione più recente del file di
installazione di Automation 360: A-People Downloads page (Login required).

2. Nella pagina Download, fai clic sul collegamento al file di installazione di Automation 360 più recente.
3. Fai clic su Installazione e configurazione, quindi fai clic su Installazione Linux o

Installazione Windows in base al sistema operativo del computer su cui desideri installare
Automation 360.

4. Scarica il file Automation360_Build_<build-number>.<file-extension>.
5. Installa la versione più recente di Automation 360 senza disinstallare la versione corrente.

Installing Control Room On-Premises alla pagina 838

Importante:  È necessario utilizzare il database SQL della versione corrente nella versione più
recente di Automation 360.

Concetti correlati
Migrazione a Automation 360 alla pagina 1126

Aggiornamento di Automation 360 su Microsoft Windows Server
utilizzando gli script
Aggiorna Automation 360 utilizzando uno script personalizzato con parametri per mantenere le
configurazioni utente esistenti.
To perform the task, you must have a  administrator account with the required rights and permissions.
• Verify Automation 360 On-Premises prerequisites alla pagina 840.
• Assicurati di disporre di quanto segue:

• Automation Anywhere Control Room installation file
• TLS certificate
• License file

Sample config.properties file:  Come riferimento, puoi trovare un file config.properties di esempio alla
fine della pagina.

Crea ed esegui uno script PowerShell per aggiornare Automation 360.
1. Crea uno script PowerShell con i parametri richiesti:

Di seguito è riportato uno script PowerShell di esempio per l'aggiornamento di Automation 360:

# Script Begins
# It fetches Data from config.properties file present under the same
 directory level

$PropertyFilePath = 'C:\script\config.properties'
$rawProperties = cat $PropertyFilePath
$propertiesToConvert = ($rawProperties -replace '\\' ,'\\') -join
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[Environment]:: NewLine;
$properties=ConvertFrom-StringData $propertiesToConvert
$env:SEE_MASK_NOZONECHECKS = 1

# Setting up the logger and InstallerRoot Directory

$baseLogFilePath=$properties.baseLoggingDirectory
$logFilePath=$baseLogFilePath+'Express_CR_Installation_Scenario1.txt'
$baseInstallerPath=$properties.baseInstallerDirectory
$installer_name_regex=$properties.installerNameRegex

# Logging Begins

Start-Transcript -Path $logFilePath -Append -IncludeInvocationHeader

$binary = Get-ChildItem $baseInstallerPath | Where-Object { $_.FullName -
imatch $installer_name_regex }
$a = $binary.FullName
$final_commandline = " /update /s /v/qn /v""/L*v
 CR_Onprem_Installationlog_Scenario1.txt"""

# Recording the Start Time
Get-Date -Format g

# Invoking the Installer here
$processdetail = (Start-Process -FilePath $a -ArgumentList
 $final_commandline -Wait -Passthru).ExitCode

# Recording the End  Time
Get-Date -Format g

Stop-Transcript

2. Opzionale: Personalizza lo script per includere i parametri in base alle tue esigenze.
3. Salva lo script nel server di installazione.
4. Accedi a al server di installazione come amministratore.
5. Avvia PowerShell in modalità amministratore.
6. Esegui questo comando:

Set-ExecutionPolicy Unrestricted -Scope CurrentUser -Force

.\install.ps1

Nota:  I log di installazione invisibile vengono memorizzati nella cartella da cui viene eseguito lo script
di installazione. Ad esempio, se esegui lo script da C:\Silent Install, i log vengono memorizzati
nella cartella C:\Silent Install.

7. Convalida quanto segue:
• Tutti i servizi Automation Anywhere sono in esecuzione in Gestione attività di Windows.

Verifying Automation Anywhere services alla pagina 968
• È possibile accedere a Control Room da un browser supportato.

Accesso alla Automation Anywhere Control Room alla pagina 1022
• È possibile installare la licenza richiesta in Control Room.

Installazione di licenze aggiuntive alla pagina 2794
• Tutte le automazioni (implementate e pianificate) sono in esecuzione in Control Room.

Attività alla pagina 2611
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Esempio di file config.properties

# Properties utilized across all Scenarios

# Default/Express Mode Params

baseLoggingDirectory=C:\script\logs\
baseInstallerDirectory=C:\script\
installerNameRegex=AutomationAnywhereEnterprise_A2019

Installazione e aggiornamento Automation 360 IQ Bot
This collection of topics guide you through the process of installing or setting up Automation 360 IQ Bot
On-Premises and Cloud.
• Automation 360 IQ Bot Cloud distribuito
• On-Premises Automation 360 IQ Bot

Automation 360 IQ Bot On-Premises

Passaggio 1: Pre-installazione Visita il sito di supporto di Automation Anywhere
per scaricare e installare il pacchetto Automation
360 IQ Bot On-Premises:
A-People Downloads page (Login required)

Nota:  Automation 360 IQ Bot On-Premises utilizza
un cluster a 3 nodi per garantire una disponibilità
elevata (HA).
High availability and disaster recovery overview

Prima di installare IQ Bot, esamina e verifica
i requisiti e le opzioni. This topic provides you
with important information about the supported
operating systems, hardware and software
requirements, and the prerequisite steps you have
to complete even before you begin the installation
process.

Prerequisiti per
l'installazione di IQ Bot
alla pagina 1068

Verify the hardware,
software, and
configuration required
to install IQ Bot On-
Premises.

Passaggio 2: Installazione di IQ Bot Installa IQ Bot utilizzando una delle seguenti
opzioni di installazione:

Installazione di IQ Bot
in modalità Express alla
pagina 1078

Installare IQ Bot in
modalità Express con le
impostazioni predefinite.
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Installazione di IQ
Bot in modalità
Personalizzazione alla
pagina 1079

Utilizza la modalità
Personalizzazione
per installare IQ
Bot con i dettagli di
configurazione.

Installazione di IQ Bot
in modalità cluster alla
pagina 1083

Installare IQ Bot
in modalità cluster
per migliorare la
produttività. IQ Bot
supports clustering
of up to five IQ Bot
installations.

Installazione di IQ Bot
in modalità Cluster
su Amazon EC2 alla
pagina 1087

Installare IQ Bot in
modalità cluster su
Amazon Elastic Compute
Cloud (Amazon EC2).

Passaggio 3: Post-installazione Dopo aver scaricato IQ Bot, registralo con Control
Room ed esegui le varie configurazioni in base alle
esigenze. Puoi anche utilizzare la lista di controllo
per assicurarti che tutti i servizi, i database, le
tabelle e le impostazioni di configurazione siano
presenti.

Lista di controllo post-
installazione alla pagina
1088

Verifica che sia installato
il IQ Bot, che i servizi IQ
Bot siano in esecuzione
utilizzando le API di
controllo dell'integrità e
registra il IQ Bot con la
Control Room.

Passaggio 4 (facoltativo): Installazione di un
motore OCR

Durante l'installazione di IQ Bot, il sistema imposta
la versione di Tesseract Optical Character Reader
più recente come motore OCR predefinito. Per
utilizzare un motore diverso, procedi nel modo
descritto nel relativo collegamento:
Utilizzare Microsoft Azure Computer Vision OCR engine
alla pagina 1098
Utilizzo del motore ABBYY FineReader Engine OCR in
IQ Bot alla pagina 1101
Utilizzo del motore Google Vision API OCR alla pagina
1104
Utilizzo del motore Tegaki API OCR alla pagina 1107

Passaggio 5: Accedi e imposta Control Room Crea e registra gli utenti specifici IQ Bot in Control
Room. Ulteriori informazioni sui ruoli e sulle
autorizzazioni di accesso di IQ Bot:
IQ Bot user personas and roles alla pagina 2476

Avanti: Connettiti a IQ Bot con il ruolo
utente assegnato e inizia a creare istanze di
apprendimento

Automation 360 IQ Bot alla pagina 2472
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Automation 360 IQ Bot Cloud distribuito

Segui questi passaggi per distribuire e registrarti come utente:

Passaggio 1: Pre-installazione Se sei l'amministratore principale della tua azienda
e hai ordinato Cloud distribuito Automation 360 IQ
Bot, riceverai un'e-mail da Automation Anywhere
con il tuo URL e le credenziali.

Passaggio 2: Log in to IQ Bot Per accedere a Automation 360, apri l'URL Control
Room nel browser, immetti le credenziali nella
schermata di accesso e fai clic su Accedi.
Accesso alla Automation Anywhere Control Room alla
pagina 1022

Passaggio 3: Impostare Control Room Crea e registra gli utenti specifici IQ Bot in Control
Room. Ulteriori informazioni sui ruoli e sulle
autorizzazioni di accesso di IQ Bot:
IQ Bot user personas and roles alla pagina 2476

Avanti: Connettiti a IQ Bot con il ruolo
utente assegnato e inizia a creare istanze di
apprendimento

Vai alla dashboard di Control Room per accedere
all'URL di collegamento a IQ Bot.
Automation 360 IQ Bot alla pagina 2472

Concetti correlati
Automation 360 IQ Bot alla pagina 2472
Automate document-centric business processes, end to end, by using IQ Bot, a web-based, Cloud-native
intelligent document processing solution that can read and process complex documents and email. This
solution combines RPA with AI techniques to extract and classify semi-structured and unstructured data.
Introduzione a Automation 360 Cloud alla pagina 827
Utilizza queste attività per iniziare a creare e utilizzare i bots con Automation 360 Cloud.
Migrazione a Automation 360 IQ Bot alla pagina 1339
La migrazione è il processo di aggiornamento dalle versioni precedenti di IQ Bot (Enterprise 11.x, 6.x o
5.x) alla versione Automation 360 IQ Bot più recente. Questa procedura include la replica del database e
dell’archivio esistenti, la conversione dei bots in formato Automation 360 e la migrazione di tutte le istanze
di apprendimento.

Prerequisiti per l'installazione di IQ Bot
Verify the hardware, software, and configuration required to install IQ Bot On-Premises.

Nota:  This page applies to On-Premises installations only. For Cloud deployment, see Automation 360 IQ
Bot Cloud distribuito alla pagina 1068.

Requisiti hardware e software

Importante:  Come passaggio di prerequisito, apri le porte 4369 e 25672 e aggiungi regole del firewall in
entrata per consentire il traffico verso queste porte su ciascuna macchina di destinazione. Per aggiungere
nodi al cluster, sincronizza i cookie RabbitMQ v3.8.18 per abilitare l'esecuzione di qualsiasi comando
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RabbitMQ v3.8.18. Se IQ Bot è già stato installato nella macchina di destinazione, pulisci e rimuovi i cookie
esistenti.

Compatibilità delle versioni di Automation 360 IQ Bot
alla pagina 740
Requisiti di sistema di IQ Bot alla pagina 1070

Prerequisito

Passaggi da effettuare come prerequisiti di IQ Bot alla
pagina 1072
Configurazione del servizio di IQ Bot alla pagina
1073
Servizi Windows di IQ Bot alla pagina 1074
Aggiornamento di RabbitMQ v3.8.18 e di Erlang/OTP
alla pagina 1075
Installazione di IQ Bot in modalità cluster in computer
con IQ Bot preinstallato alla pagina 1076
Prerequisiti per l'installazione di IQ Bot in Modalità
Express alla pagina 1077

Limitazioni dell'installazione

Limiti di crittografia del database
Il tempo di installazione aumenta quando è in corso la crittografia del file di backup del database SQL e
anche quando la dimensione del file di backup del database aumenta.
Il processo di crittografia del database SQL potrebbe causare la creazione di log di transazioni di grandi
dimensioni. Assegna uno spazio su disco almeno 3 - 4 volte superiore alla dimensione del file di backup del
database.

Nota:  The following list of installation packages are not supported from Automation 360.27 release
onwards:
• On-Premises custom fresh installation - Custom installation + HTTP + SQL authentication + local

account installation
• On-Premises Express fresh installation
• On-Premises without internet fresh installation
• On-Premises GCP fresh and upgrade
• On-Premises SDS fresh installations (AD and Non-AD)
• On-Premises Migration from IQ Bot 11.x to On-Premises Automation 360.x using Migration Assistant

Tool (MAT).

Nota:  The base version must be Version 11.3.5.6. Any customer on IQ Bot 11.x version prior to On-
Premises must first upgrade to On-Premises and then migrate to Automation 360.27.

Attività correlate
Installazione di IQ Bot in modalità Express alla pagina 1078
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Installare IQ Bot in modalità Express con le impostazioni predefinite.
Installazione di IQ Bot in modalità Personalizzazione alla pagina 1079
Utilizza la modalità Personalizzazione per installare IQ Bot con i dettagli di configurazione.

Requisiti di sistema di IQ Bot
Verifica la compatibilità del sistema operativo e del database, le informazioni del database e i requisiti
hardware e software per Automation 360 IQ Bot.

Legal disclaimer:  Le informazioni fornite in questo flusso di lavoro possono variare a seconda dell'offerta
utilizzata. Le istruzioni di amministrazione potrebbero non essere applicabili a Automation 360 IQ Bot
Community Edition.

Nota:  When you migrate from any of the earlier IQ Bot versions (11.x or 6.x) to Automation 360 IQ Bot,
ensure that you update the Microsoft Windows Server Operating System to one of the versions listed in the
table below.

The following table lists the Operating System and database compatibility with Automation 360 IQ Bot On-
Premises:

Operating System Piattaforme
supportate

Tipo di database Versione
database

Edizione
database

Microsoft Windows
Server:
• Data Center 2019
• Data Center 2016
• R2 2016 standard
• R2 2019 standard

• Macchine virtuali
Microsoft Azure

• Amazon Elastic
Compute Cloud
(Amazon EC2)

• Google Cloud
Platform

• Microsoft SQL
Azure (RTM)

• Servizio di
database
relazionale
Amazon
(Amazon RDS)

• Microsoft SQL
Server

• 2019
• 2017
• 2016
• 2014
• 2012

• Express
• Standard
• Enterprise

The following table provides the required database information:

Database Microsoft SQL Server e Amazon RDS

Informazioni richieste Descrizione

Autenticazione del database (SQL Server) Fornire le credenziali per l'utente Microsoft SQL Server
con l'autorizzazione per connettersi al database.

Nome database IQBot

Porta di database Impostazione predefinita: 1433

Credenziali di servizio Fornisce all'utente le seguenti autorizzazioni:
• CONNESSIONE SQL
• CREAZIONE DI QUALSIASI DATABASE
• VISUALIZZAZIONE DI QUALSIASI DATABASE

Nota:
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If you are using an older version of the Microsoft SQL Server which does not support TLS 1.2,
then you must keep a IQ Bot database backup and update to a Microsoft SQL Server version that
supports TLS 1.2. For more information, see https://support.microsoft.com/en-us/topic/kb3135244-
tls-1-2-support-for-microsoft-sql-server-e4472ef8-90a9-13c1-e4d8-44aad198cdbe.

Requisiti hardware

IQ Bot Minimum requirements

Application server • 32 GB di RAM
• Processore a 8 core con supporto per set di

istruzioni AVX (questo è un requisito a partire
da A2019.19)

• 500 GB di spazio su disco rigido
• Assicurati che l'unità C abbia oltre 100 GB di

spazio libero sul disco rigido

Per tutti i server del database correlati a IQ Bot • 16 GB di RAM
• Processore a 8 core
• 500 GB di spazio su disco rigido

Nota:  Se ospiti database IQ Bot insieme
ad altri database di applicazioni, assicurati
di aumentare, proporzionalmente le risorse
hardware.

Microsoft Azure SQL Database: production
environment

• vCore model (recommended)
• DTU model (Premium tier recommended)

Requisiti software

Software Dettagli

Sistema di gestione dei database Matrice di confronto delle funzionalità per
Automation 360 IQ Bot alla pagina 735

Automation Anywhere Control Room Compatibilità delle versioni di Automation 360 IQ
Bot alla pagina 740

Browser Web Google Chrome 80 (o versione successiva)
Microsoft Edge Chromium 98 (or later)
Mozilla Firefox 80 (or later)

SMB File Share Azure File Share with Server Message Block 2.0
and 3.x (SMB) protocol.

© 2023 Automation Anywhere. All rights reserved.     1071

https://support.microsoft.com/en-us/topic/kb3135244-tls-1-2-support-for-microsoft-sql-server-e4472ef8-90a9-13c1-e4d8-44aad198cdbe
https://support.microsoft.com/en-us/topic/kb3135244-tls-1-2-support-for-microsoft-sql-server-e4472ef8-90a9-13c1-e4d8-44aad198cdbe


    Automation Anywhere - Installazione e aggiornamento Automation 360

Software Dettagli

Dipendenze Automation 360 richiede il seguente software,
che viene installato automaticamente durante il
processo di installazione:
• Microsoft .NET Framework v4.7.2

Il sistema richiede un riavvio per completare
l'aggiornamento.

• Microsoft Visual C++ Redistributable 2017
x64 package

• Erlang 25.1 (13.1)
• RabbitMQ 3.10.8
• NodeJS v14.20.0
• Microsoft SQL Server 2012 Native Client- QFE
• Python 3.11.0 (64 bit)
• Java Virtual Machine (JVM) 8

Nota:  In un ambiente cluster, tutte le
dipendenze vengono installate su ogni computer
in cui IQ Bot è installato.

Riferimenti correlati
Prerequisiti per l'installazione di IQ Bot alla pagina 1068
Verify the hardware, software, and configuration required to install IQ Bot On-Premises.

Passaggi da effettuare come prerequisiti di IQ Bot
Completare la procedura prima di iniziare l'installazione di IQ Bot.
1. L'utente deve disporre del ruolo SYSADMIN o dei seguenti privilegi per l'account di database SQL,

poiché questo viene utilizzato durante l'installazione per creare il database ed eseguire l'istruzione
BULK INSERT.
• Connessione SQL (CONNESSIONE SQL)
• Creazione del database (CREAZIONE DI QUALSIASI DATABASE)
• Visualizzazione di qualsiasi database (VISUALIZZAZIONE DI QUALSIASI DATABASE)

Nota:  L'installazione con Microsoft Azure SQL richiede il ruolo dbmanager.

Nota:  L'installazione con AWS RDS richiede un ruolo con i tre privilegi menzionati in precedenza.
These privileges are already assigned to the db_owner role in RDS.

Concedi le autorizzazioni per un utente di database specifico e visualizza le autorizzazioni per quel
ruolo utilizzando la seguente query TSQL:
SELECT * FROM fn_my_permissions(NULL, 'SERVER').
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2. Abilita innanzitutto HTTPS, per configurare IQ Bot con HTTPS. Tieni pronti per l'uso i seguenti file di
certificato HTTPS:
• Control Room certificate in .crt format (Certificate Authority list bundle).
• Certificato di Control Room in formato .crt (certificato pubblico lato server).
• Certificato server IQ Bot in formato .pfx e .crt.

Importante:  Installa manualmente i certificati .crt per Control Room negli archivi dei certificati
appropriati.

Nota:  Per ulteriori informazioni, vedi Configurazione di IQ Bot con HTTP quando Control Room è
configurato con HTTPS alla pagina 1096.

3. Tieni le seguenti porte aperte, in quanto sono utilizzate dai servizi di IQ Bot:
• Porta di accesso alle applicazioni (configurabile): 3000
• Porta di accesso al database (configurabile): 1433
• Porte dei servizi delle applicazioni interni (fisse): 8100, 9002, 9991, 9992, 9995, 9996, 9997, 9998,

9999
• Porte di ascolto in entrata:

• 47100-47200 sul server IQ Bot per la comunicazione IQ Bot-Control Room.
• 47100-47200 e 47500-47600 sul server di Control Room.

• RabbitMQ v3.8.18
• Porta: 5672
• Porta: 5673

4. Se la versione in uso di SQL Server è precedente a SQL Server Native Client 2012, viene visualizzata
una finestra di dialogo che consente di eseguire l'aggiornamento. Apri Services.msc e arresta SQL
Server (MSSQLSERVER) per eseguire l'aggiornamento. Quindi, continua con il processo di installazione.

5. Durante il processo di aggiornamento, lo strumento di installazione rileva l'eventuale presenza
di istanze di apprendimento provenienti da una versione di IQ Bot precedente. Per mantenere il
classificatore originale per tali istanze di apprendimento, seleziona la versione di IQ Bot precedente
dall'elenco a discesa. Questo garantisce coerenza nel comportamento delle istanze di apprendimento
con tale versione precedente.

6. Lo strumento di installazione di IQ Bot distingue tra maiuscole e minuscole sull'account utente creato
per SQL Server o Window.

Importante:  Use the username as it appears on the Microsoft SQL Server Management Studio under
Security > Logins. Se è stato creato in maiuscolo, utilizza il maiuscolo per il nome utente per avviare
il programma di installazione. Inoltre, verifica se la proprietà del database di confronto è impostata
sulla distinzione tra maiuscole e minuscole.

Configurazione del servizio di IQ Bot
In alcune distribuzioni di IQ Bot, l'account del servizio può essere diverso da quello di accesso. As an
administrator, provide the service credentials during installation.
Lo strumento di installazione di IQ Bot supporta le credenziali del servizio durante l'autenticazione con
Microsoft Windows o SQL server Durante l'installazione di servizi per IQ Bot, nella finestra di installazione
del servizio, la casella di controllo Account di sistema locale è selezionata per impostazione predefinita.
Puoi deselezionarla e fornire un nome utente e una password.
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Nota:
• Utilizza l'autenticazione Windows con un utente amministratore di sistema valido nella configurazione

del servizio.
• Utilizza l'autenticazione Windows con il sistema locale per un utente amministratore di sistema.
• Se utilizzi il server SQL remoto per creare un database, la combinazione dell'account di sistema locale

per le credenziali del servizio e l'autenticazione Windows per la connessione SQL non è supportata.
• L'account del servizio utilizzato per i servizi di IQ Bot deve disporre di diritti completi per la cartella di

installazione di IQ Bot

Se non la casella di controllo Account di sistema locale non viene selezionata, devi fornire le tue
credenziali utente per eseguire i servizi IQ Bot.

Nota:
• Un utente amministratore di sistema valido richiede l'autenticazione Window con le credenziali utente

dei servizi.
• Quando immetti le credenziali utente, assicurati che le credenziali siano associate a un dominio. Ad

esempio: esempio.com/testuser. L'utente non è in grado di utilizzare questa funzione senza il dominio.

Fai riferimento a Installazione di IQ Bot in modalità Personalizzazione alla pagina 1079 per visualizzare l'uso
delle credenziali del servizio in IQ Bot.
Riferimenti correlati
Prerequisiti per l'installazione di IQ Bot alla pagina 1068
Verify the hardware, software, and configuration required to install IQ Bot On-Premises.

Servizi Windows di IQ Bot
IQ Bot I servizi Windows vengono installati automaticamente durante l'installazione e la configurazione.
Assicurati che i seguenti servizi Windows vengano impostati durante l'installazione di IQ Bot.

Nome servizio Descrizione

Automation Anywhere Cognitive Alias Servizio di IQ Bot che gestisce i domini, il
dizionario di dominio, gli alias e le lingue
supportati nel sistema.

Automation Anywhere Cognitive Application Servizio di IQ Bot che fornisce supporto
per tutti i punti di integrazione di Control
Room e informazioni sulla configurazione
dell'applicazione IQ Bot.

Automation Anywhere Cognitive Classifier Servizio di IQ Bot che fornisce supporto per la
classificazione dei documenti in un'istanza di
apprendimento, in gruppi diversi.

Automation Anywhere Cognitive Console Interfaccia utente di IQ Bot.

Nota:  In contrast to other services, the
Automation Anywhere Cognitive Console service
runs on the local user account rather than the
domain or service account.
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Nome servizio Descrizione

Automation Anywhere Cognitive File Manager Servizio di IQ Bot che gestisce i documenti nel
sistema di gestione di file.

Automation Anywhere Cognitive Gateway-2 Gateway di IQ Bot per tutti i servizi di back-
end di IQ Bot, gestione dell'autorizzazione e
convalida della richiesta/risposta delle API.

Automation Anywhere Cognitive MLScheduler
Service

Utilità di pianificazione del servizio di IQ Bot per
il servizio web ML.

Automation Anywhere Cognitive MLWeb Service Servizio di IQ Bot che prepara i modelli in base
alla convalida dell'utente.

Automation Anywhere Cognitive Project Servizio di IQ Bot che gestisce le istanze di
apprendimento.

Automation Anywhere Cognitive Report Dashboard di IQ Bot.

Automation Anywhere Cognitive Validator Servizio di IQ Bot per la gestione dei documenti
sottoposti a convalida.

Automation Anywhere Cognitive VisionBot
Manager

Servizio di IQ Bot per la gestione dei bot di
visione nel sistema.

Automation Anywhere Cognitive VisionBotEngine
Service

Servizio di IQ Bot per l'elaborazione dei
documenti in base ai diversi input forniti.

Nota:  Tutti i servizi possono essere configurati nell'account di sistema locale o di dominio quando IQ Bot
viene installato in modalità personalizzata. Per IQ Bot installato in Modalità Express, tutti i servizi vengono
eseguiti nell'account di sistema locale.

Riferimenti correlati
Prerequisiti per l'installazione di IQ Bot alla pagina 1068
Verify the hardware, software, and configuration required to install IQ Bot On-Premises.

Aggiornamento di RabbitMQ v3.8.18 e di Erlang/OTP
Il pacchetto di installazione IQ Bot include la versione 3.7.17 di RabbitMQ v3.8.18 e la versione 22.0 di
Erlang/OTP.
Per Automation 360 IQ Bot, assicurati di scaricare la versione Microsoft Visual C++ Redistributable 2017
x64, in quanto è necessaria per la versione di Erlang/OTP più recente.
Le seguenti informazioni spiegano diversi scenari per l'aggiornamento di RabbitMQ v3.8.18/Erlang/OTP:
• Nuova installazione di IQ Bot

Per una nuova installazione, non è necessario eseguire alcuna procedura aggiuntiva, poiché RabbitMQ
v3.8.18 e Erlang/OTP sono inclusi nel pacchetto di installazione.di IQ Bot. Questi programmi vengono
installati automaticamente durante il processo di installazione.
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• Aggiornamento dalla versione precedente di IQ Bot
Disinstalla la versione precedente di RabbitMQ v3.8.18/Erlang/OTP.
1. Disinstalla le copie di RabbitMQ v3.8.18 e di Erlang/OTP esistenti dal Pannello di controllo.
2. Esegui il file Cleanup_Components.bat come amministratore.
3. Riavvia il computer.
4. Dopo aver eseguito gli script, verifica che RabbitMQ v3.8.18 e Erlang/OTP siano stati rimossi

completamente. In caso contrario, disinstallali manualmente per eliminare i file rimanenti dalla
cartella dei file di programma, quindi ripeti il passaggio 3.

• Una versione precedente di RabbitMQ v3.8.18/Erlang/OTP è presente sul computer e
l'utente desidera eseguire l'aggiornamento alle versioni più recenti:
Devi rimuovere manualmente le versioni precedenti dal sistema utilizzando un file di utilità batch fornito
da Automation Anywhere. Contatta il team di supporto di Automation Anywhere per ottenere l'utilità. È
quindi possibile procedere con l'installazione di IQ Bot.

Riferimenti correlati
Prerequisiti per l'installazione di IQ Bot alla pagina 1068
Verify the hardware, software, and configuration required to install IQ Bot On-Premises.

Installazione di IQ Bot in modalità cluster in computer con IQ Bot
preinstallato
Se IQ Bot è già installato sul computer, è necessario disinstallare IQ Bot, arrestare il servizio RabbitMQ ed
eliminare i cookie di RabbitMQ v3.8.18 esistenti, prima di installare IQ Bot in modalità cluster.
• Apri le porte 4369 e 25672 e aggiungi regole del firewall in entrata per consentire il traffico verso

queste porte su ciascuna macchina di destinazione.
• Per aggiungere nodi al cluster, sincronizza i cookie di RabbitMQ v3.8.18 per abilitare l'esecuzione di

qualsiasi comando di RabbitMQ v3.8.18. Se IQ Bot è già stato installato nella macchina di destinazione,
pulisci e rimuovi i cookie esistenti.

Prima di configurare un cluster, effettua la seguente procedura di pulizia:
1. Disinstalla IQ Bot da Programma e funzionalità.
2. Arresta il servizio RabbitMQ v3.8.18, eseguendo il comando: net stop RabbitMQ /yes.
3. Disinstalla RabbitMQ v3.8.18 da %Programfiles%\RabbitMQ Server\uninstall.
4. Arresta epmd.exe e i relativi discendenti eseguendo questo comando: Taskkill /IM epmd.exe /

F.
5. Arresta erl.exe e erlsrv.exe e i relativi discendenti eseguendo i seguenti comandi:

a) Taskkill /IM erl.exe /F

b) Taskkill /IM erlsrv.exe /F

6. Uninstall Erlang from %Programfiles%\erl8.2\Uninstall.
7. Rimuovi le seguenti cartelle se non erano state rimosse durante la disinstallazione:

a) %Programfiles%\Rabbit MQ Server

b) %Programfiles%\erl8.2

8. Rimuovi le seguenti cartelle: %appdata%\RabbitMQ, %WINDIR%\.erlang.cookie,
%USERPROFILE%\.erlang.cookie.
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Dopo aver completato la procedura di installazione, procedi nel modo seguente:
• Sono disponibili dettagli del bilanciamento del carico per quanto segue:

nome del bilanciamento del carico
porta
tipo di sicurezza utilizzata (ad esempio, HTTP o HTTPS)

• Condividi una cartella per la configurazione del percorso di output.

Nota:  L'installazione utente di IQ Bot richiede le autorizzazioni di accesso appropriate.

Riferimenti correlati
Prerequisiti per l'installazione di IQ Bot alla pagina 1068
Verify the hardware, software, and configuration required to install IQ Bot On-Premises.

Prerequisiti per l'installazione di IQ Bot in Modalità Express
Soddisfacimento dei prerequisiti per la configurazione IQ Bot in modalità express.
Prima di iniziare l'installazione IQ Bot in Modalità Express, completa i passaggi seguenti.
1. Installa in Control Room una versione compatibile con IQ Bot.

Compatibilità delle versioni di Automation 360 IQ Bot alla pagina 740
2. Assicurati che il servizio SQL Server Browser sia installato e funzionante prima di installare IQ Bot in

Modalità Express.
3. Puoi avviare il servizio SQL Server Browser in uno dei seguenti modi:

Opzione 1 a. Avvia Gestione configurazione SQL
Server.

b. Accedi a Servizi SQL Server.
c. Avvia i servizi SQL Server Browser.

Opzione 2 a. Avvia lo strumento Gestione attività.
b. Accedi alla scheda Servizi.
c. Avvia i servizi SQLBrowser.

4. Use the Automation_Anywhere_IQ_BOT_<version_number>.exe file to install IQ Bot.
5. La procedura di installazione guidata assiste l'utente durante il processo di installazione. Durante

l'installazione vengono installati anche eventuali prerequisiti o dipendenze software mancanti.

Nota:  Quando un file viene caricato in una nuova istanza di IQ Bot, l'amministratore del database
non può estrarre eventuali informazioni su tale file dal database perché i dati sono crittografati.

6. Abilita l'autenticazione SQL.
Abilita il protocollo TCP sul server SQL, il quale deve ascoltare l'host locale sulla porta 1433.

7. Imposta il nome dell'istanza del server SQL su AACRSQLEXPRESS.
8. Crea un utente con autorizzazioni sysadmin per nome utente aaadmin e password aabots@123.

Per informazioni sull'installazione in Modalità Express, vedi Installazione di IQ Bot in modalità Express alla
pagina 1078.
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Riferimenti correlati
Prerequisiti per l'installazione di IQ Bot alla pagina 1068
Verify the hardware, software, and configuration required to install IQ Bot On-Premises.

Installazione di IQ Bot in modalità Express
Installare IQ Bot in modalità Express con le impostazioni predefinite.
Completa i prerequisiti elencati in: Prerequisiti per l'installazione di IQ Bot in Modalità Express alla pagina
1077
1. Fai doppio clic sul file Automation_A360_IQ_BOT_<build number>.exe.
2. Nella procedura di installazione guidata di IQ Bot, fai clic su Sì, quindi fai clic su Avanti.
3. Nella pagina Prerequisiti, esamina i prerequisiti e fai clic su Avanti.
4. Nella pagina Contratto di licenza, esamina il contratto di licenza, accetta i termini e fai clic su

Avanti.
IQ Bot esegue un controllo di pre-installazione.
Viene visualizzata la schermata di pre-installazione, in cui sono mostrate le applicazioni che non hanno
la versione richiesta e le porte necessarie insieme ai servizi che occupano tali porte.

5. Se il controllo di pre-installazione non riesce, il software menzionato viene disinstallato e le porte
richieste vengono liberate.
a) Fai clic su Riprova.
b) Una volta completato il controllo di pre-installazione, fai clic su Avanti.

Viene visualizzata la pagina Tipo di installazione con le opzioni Express e Personalizzata.

Nota:  L'installazione Express installa IQ Bot basato su HTTP senza il supporto di Active Directory.

6. Seleziona Express e fai clic su Avanti.
7. Dopo aver fatto clic su Avanti, potrebbe essere visualizzato il messaggio Impossibile procedere

con l'installazione se il programma di installazione non è in grado di comunicare con Control
Room o SQL Express.
Se viene visualizzato il messaggio di errore, procedi nel modo seguente:
a. Fai clic su Indietro per rivedere o modificare le impostazioni di installazione. In alternativa, esci

dalla procedura di installazione guidata e fai clic su Annulla.
b. Nella finestra di dialogo di conferma, fai clic su Sì per uscire dall'installazione guidata.

In questo modo viene eseguito il roll-back di tutte le modifiche.
c. Fai clic su No per riprendere.

8. Nella pagina Pronto per l'installazione del programma, fai clic su Installa.
Viene avviata l'installazione rapida e dopo alcuni minuti il sistema mostra la pagina Operazione
completata a indicare che l'installazione è stata completata correttamente.

IQ Bot viene installato con le seguenti impostazioni predefinite:
Security type: None (HTTP)
Web configuration: <web url:port>
Database configuration: <database url:port> (user: aaadmin ; Authentication: SQL)
Database password: aabots@123
Host Gateway: <gateway:port> (SSL Offloading: No)
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Output path: C:\Users\Public\Documents\Automation Anywhere IQBot Platform
\Output\
Logging Path: C:\Users\Public\Documents\Automation Anywhere IQBot Platform\Logs
\
Logging path Automation 360 IQ Bot A360.21 onward: C:\Users\Public\Documents
\Automation 360 IQBot Platform\Logs\
Installation path for Automation 360 IQ Bot: C:\Program Files (x86)\Automation Anywhere
 IQ Bot A2019\
Installation path for Automation 360 IQ Bot A360.21 onward: C:\Program Files
 (x86)\Automation 360 IQ Bot\

Verifica che sia installato il IQ Bot, che i servizi IQ Bot siano in esecuzione utilizzando le API di controllo
dell'integrità e registra il IQ Bot con la Control Room. Lista di controllo post-installazione alla pagina 1088

Installazione di IQ Bot in modalità Personalizzazione
Utilizza la modalità Personalizzazione per installare IQ Bot con i dettagli di configurazione.
1. Esegui il file di installazione Automation_A360_IQ_BOT_<build number>.exe come

amministratore.
2. Per le installazioni eseguite per la prima volta, potrebbe essere necessario riavviare il server dopo il

completamento del processo. Se necessario, riavvia il processo di installazione di IQ Bot.
3. Nella procedura di installazione guidata di Automation Anywhere IQ Bot, fai clic su Avanti.

a) Fai clic su Avanti nella finestra Prerequisiti.

4. Leggi il contratto di licenza, accetta i termini e fai clic su Avanti.
IQ Bot esegue una verifica pre-installazione.
Viene visualizzata la schermata di pre-installazione, in cui sono mostrate le applicazioni che non hanno
la versione richiesta e le porte necessarie insieme ai servizi che occupano tali porte.

5. Se la verifica di pre-installazione non riesce, disinstalla il software indicato e libera le porte richieste.
a) Fai clic su Riprova.
b) Quando la verifica di pre-installazione restituisce un esito positivo, fai clic su Avanti.

Viene visualizzata la pagina Tipo di installazione con le opzioni Express e Personalizzata.

Nota:  L'installazione Express installa IQ Bot basato su HTTP senza il supporto di Active Directory.

6. Seleziona l'opzione Personalizzazione e fai clic su Avanti.
7. Nella finestra Configurazione database, aggiungi i seguenti dettagli:

a) Nome host o IP: immetti il nome host o l'indirizzo IP.

Nota:  Il carattere di sottolineatura non è accettato nel nome host.

b) Porta: immetti il numero della porta.

Nota:  Se un database Microsoft Windows SQL Server Express è installato localmente sul
computer di destinazione, il nome host viene popolato automaticamente come localhost e la porta
come 1433.
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8. Opzionale: To connect to your CyberArk vault to store the custom keys for encrypting and decrypting
IQ Bot data, select the Use CyberArk external vault option and provide the following connection
details to your CyberArk account.
• Vault URL: The CyberArk URL endpoint on the CyberArk server
• Application ID: The CyberArk-issued Application ID
• Object and Safe Name: Identify the custom key in CyberArk
• Client certificate path: The Control Room Client Certificate certificate used to authenticate

to CyberArk. If the certificate is distributed in a passphrase protected file, you must enter the
passphrase.

• (Optional) Server certificate: You can load the CyberArk AIM Server certificate to the Control
Room trust store here to make sure that the Control Room will trust the CyberArk server.

Ottieni i dettagli di connessione dal tuo fornitore CyberArk o dal team IT.
9. Immetti i seguenti dettagli del server di database nella finestra Configurazione database e fai clic

su Avanti.
Opzione Descrizione

Opzione 1 Specifica le credenziali utente di Microsoft
Windows SQL Server per accedere al server di
database.

Opzione 2 Se selezioni la casella di controllo Usa
autenticazione Windows, non è necessario
fornire le credenziali di Microsoft Windows
per accedere al server di database poiché
il programma di installazione le rileva
automaticamente.

Viene visualizzato il messaggio di errore Impossibile connettersi a SQL Server con la
configurazione specificata se si verificano i seguenti scenari:
• Il nome/l'indirizzo IP del server e il numero di porta sono errati
• Le credenziali del server di database sono errate
• I privilegi utente sono insufficienti per connettersi al database

Nota:
• Quando installi IQ Bot, configura le credenziali di un database appena ospitato su Microsoft Azure

SQL PaaS. Possono essere necessari fino a 300 secondi per verificare le credenziali e passare
alla schermata successiva. Tuttavia, se il database in sede per IQ Bot è già stato migrato prima
dell'installazione di Microsoft Azure SQL PaaS, non ci sarà alcun ritardo durante la configurazione
del database.

• IQ Bot non supporta la logica di ripetizione per Microsoft Azure SQL PaaS. Evita di utilizzare IQ Bot
durante gli eventi di manutenzione pianificata sul database Microsoft Azure SQL.

• Quando IQ Bot e l'istanza di database esistono già, IQ Bot viene installato di nuovo e durante
l'installazione IQ Bot esegue l'istanza di database predefinita.

• Windows authentication with the local system works only if the NT Authority/System user has
system administrator permissions.

• La combinazione dell'account di sistema locale per le credenziali del servizio e dell'autenticazione
Microsoft Windows per la connessione SQL non è supportata se per creare i database viene
utilizzato il server SQL remoto.
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10. Nella finestra Configurazione servizi, seleziona la casella di controllo Account di sistema locale e
fai clic su Avanti.
• Seleziona la casella di controllo Account di sistema locale per eseguire i servizi sull'account di

sistema locale.
• Se non selezioni la casella di controllo Account di sistema locale, immetti le credenziali utente

per eseguire i servizi IQ Bot.
• Un utente amministratore di sistema valido deve autenticare Windows con le credenziali utente

dei servizi.
• Quando immetti le credenziali utente, assicurati che le credenziali siano associate a un dominio.

For example: example.com/testuser. L'utente non può utilizzare questa funzione senza il
dominio.

11. Immetti i seguenti dettagli nella finestra di IQ Bot Configurazione portale e fai clic su Avanti.

Sicurezza del portale

Seleziona il tipo di sicurezza: HTTPS o HTTP.

Se selezioni HTTPS, verifica che sia possibile navigare, quindi seleziona un file di
certificato PFX valido dal campo Percorso certificato.
Configurazione di IQ Bot con HTTP quando Control Room è configurato con HTTPS alla pagina
1096

Se selezioni HTTP, passa alla fase successiva.

Immetti una passphrase valida per il certificato nel campo Passphrase certificato.

Configurazione del portale

Nome host o IP Inserisci il nome host o l'indirizzo IP di IQ
Bot oppure utilizza il valore predefinito
compilato automaticamente, ovvero il nome
di dominio completo (Fully-Qualified Domain
Name, FQDN) della macchina su cui stai
installando IQ Bot.

Nota:  Quest'ultimo viene compilato
automaticamente per impostazione
predefinita con l'FQDN della macchina su cui
stai installando IQ Bot.

Porta Inserisci il numero di porta o utilizza il valore
predefinito compilato automaticamente,
3000.

12. Nella finestra Configurazione bilanciamento del carico, esegui le seguenti operazioni:
a) Seleziona la casella di controllo Usa come in portale IQ Bot per utilizzare lo stesso nome

host e lo stesso numero di porta per il bilanciamento del carico specificati in precedenza nella
finestra Configurazione portale di IQ Bot. Per impostazione predefinita, questa casella di
controllo è selezionata. Lascia selezionata questa casella di controllo se sussiste una delle seguenti
condizioni:
• Stai installando IQ Bot su una sola macchina
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• Prevedi di mantenere la configurazione del bilanciamento del carico uguale a quella della
pagina di IQ Bot

b) Se i valori di configurazione per il bilanciamento del carico sono diversi dalla pagina IQ Bot,
deseleziona la casella di controllo Usa come in portale IQ Bot e specifica quanto segue:
• Nome host bilanciamento del carico: immetti il nome host o l'indirizzo IP.
• Porta bilanciamento del carico: immetti il numero della porta.

c) Se necessario, seleziona la casella di controllo Il bilanciamento del carico può gestire
l'offload SSL, quindi fai clic su Avanti.

Nota:  Quando configuri il bilanciamento del carico, se imposti la modalità di sicurezza su HTTPS
nella finestra Configurazione portale di IQ Bot, l'offload SSL è disabilitato per impostazione
predefinita. Per abilitare l'offload SSL per il bilanciamento del carico, seleziona HTTP nella finestra
Configurazione portale di IQ Bot.

Di seguito sono riportate alcune opzioni di personalizzazione aggiuntive del sistema di
bilanciamento del carico:
• Se installi IQ Bot in AWS, per accedere al server IQ Bot da una posizione esterna, sostituisci il

nome del gateway host con il DNS pubblico.
• Durante la reinstallazione, il nome host del bilanciamento del carico e la porta vengono

rilevati automaticamente dal programma di installazione in base ai dettagli dell'installazione
precedente archiviati in Control Room. Puoi modificarli in base alle tue esigenze, in quanto
questo è particolarmente utile quando installi più istanze di IQ Bot ai fini della scalabilità
(perché non devi ricordare i dettagli per ogni singola istanza).

• Quando utilizzi un certificato HTTPS nel bilanciamento del carico con un nome alias diverso dal
nome host del computer (FQDN), immetti il nome alias come nome host.

• Il programma di installazione recupera il valore dalla finestra Configurazione del Portal di
IQ Bot (dalla pagina precedente), ma mostra i valori recuperati in precedenza nelle caselle di
testo disabilitate di Control Room.

13. Nella finestra Cartella di destinazione, apporta le modifiche necessarie alle cartelle di destinazione
e fai clic su Avanti.
• Percorso di installazione: seleziona un percorso di installazione diverso, se necessario.

Il percorso di installazione predefinito è: C:\Program Files(x86)\Automation Anywhere
 IQ Bot <version number>\

Da IQ Bot A360.21 in avanti: C:\Program Files (x86)\Automation 360 IQ Bot\
• Percorso di output: seleziona il percorso di output in cui archiviare l'output. Il percorso di output

può anche essere un percorso di rete condiviso. Durante la reinstallazione, il Percorso di output
viene rilevato automaticamente dal programma di installazione (in base ai dettagli dell'installazione
precedente memorizzati nel database di configurazione di IQ Bot). Modifica i dettagli se necessario.
Il percorso di output predefinito è: C:\Users\Public\Documents\Automation Anywhere
 IQ Bot Platform\Output\
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14. Nella finestra Pronto per l'installazione del programma, verifica e rivedi le impostazioni di
installazione, quindi fai clic su Installa per avviare l'installazione.
• Alla prima installazione, durante il processo, un avviso di sicurezza di Microsoft Windows potrebbe

richiedere l'autorizzazione per installare Erlang. Se richiesto, fai clic su Consenti l'accesso.
• A volte, la finestra Avviso di sicurezza Windows non è visibile (può essere nascosta dietro

altre finestre attive). Utilizza la combinazione di tasti Alt + Tab e verifica che la finestra Avviso di
sicurezza Windows non sia nascosta dietro le altre finestre visibili.

15. Fai clic su Consenti l'accesso per completare l'installazione, quindi nella finestra Installazione
completata fai clic su Fine.
Sul desktop viene creata un'icona IQ Bot.
Se si verifica un errore durante l'avvio di IQ Bot, potrebbe essere necessario riavviare Automation
Anywhere Control Room Reverse Proxy e i servizi Cognitive Console Automation Anywhere.

16. Per Control Room, imposta il file cluster.properties come richiesto in base alla versione della
release..

Verifica che sia installato il IQ Bot, che i servizi IQ Bot siano in esecuzione utilizzando le API di controllo
dell'integrità e registra il IQ Bot con la Control Room. Lista di controllo post-installazione alla pagina 1088

Installazione di IQ Bot in modalità cluster
Installare IQ Bot in modalità cluster per migliorare la produttività. IQ Bot supports clustering of up to five
IQ Bot installations.
Assicurati di disporre di un bilanciamento del carico per una configurazione cluster e per distribuire il
traffico a tutti i nodi del server applicazioni.
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1. Installa IQ Bot su ogni computer in modalità personalizzata.
• Durante l'installazione, nella schermata Configurazione del bilanciamento del carico digita il

nome dell'host e la porta del bilanciamento del carico.
• Seleziona l'opzione Il bilanciamento del carico può gestire l'offload SSL, se in grado di

supportare tale funzione, per abilitare l'offload SSL.
• Specifica il percorso di output condiviso nella schermata Cartella di destinazione.
• Durante l'installazione, utilizza gli stessi dettagli del server di database su tutti i nodi.

Installazione di IQ Bot in modalità Personalizzazione alla pagina 1079
2. Condividi la cartella di output con il ruolo di accesso Tutti.

Consulta Come rendere accessibile una cartella condivisa alla pagina 1086.
3. Utilizza il prompt dei comandi per collegare al cluster primario ogni computer che contiene

un'installazione di IQ Bot.
Consulta Configurazione del cluster RabbitMQ per IQ Bot alla pagina 1085.

4. Opzionale: Se Control Room è stata impostata in modalità Disponibilità elevata, è possibile impostare in
modalità Disponibilità elevata anche IQ Bot.
Panoramica della disponibilità elevata e del ripristino di emergenza alla pagina 1118

5. Configura il firewall per aprire le porte 4369 e 25672.
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Per ogni computer che contiene un'installazione di IQ Bot, verifica che IQ Bot sia installato, assicurati che
i servizi IQ Bot siano in esecuzione utilizzando le API di controllo dell'integrità e registra IQ Bot su Control
Room. Lista di controllo post-installazione alla pagina 1088

Nota:  Durante la registrazione di ogni installazione di IQ Bot, nel campo URL, immetti l'URL del
bilanciamento del carico.

Importante:  In una configurazione cluster, se si verifica un problema di rete temporaneo, il cluster
si interrompe. Per aggiungere nuovamente i nodi nel cluster, devi eseguire manualmente i comandi in
ciascuno dei nodi partecipanti. Devi inoltre monitorare lo stato del cluster per sapere se è integro o
danneggiato. Per evitare tali problemi, puoi configurare il cluster per il ripristino automatico in caso di
problemi di rete temporanei. Per informazioni su come attivare il ripristino automatico, consulta questo
articolo: RabbitMQ Cluster Configuration with Auto-recovery (A-People login required).

Configurazione del cluster RabbitMQ per IQ Bot
Utilizzare il prompt dei comandi per configurare tre cluster.
Completa i passaggi 1 e 2 in Installazione di IQ Bot in modalità cluster alla pagina 1083.

1. Open command prompt, navigate to {RabbitMq installation directory}\sbin and execute
the following command: rabbitmqctl.bat cluster_status.
You will see an output similar to this:Cluster status of node rabbit@IQBotCluster1 ...
 [{ nodes, [{ disc, [rabbit @IQBotCluster1] }] }, { running_nodes, [rabbit
 @IQBotCluster1] }, { cluster_name, << "rabbit@IQBotCluster1" >> },
 { partitions, [] }, { alarms, [{ rabbit @IQBotCluster1, [] }] }]

2. Esegui il comando seguente: rabbitmqctl list_queues -p test.
3. Configura il cluster primario.

a) In IQBotCluster1 VM, open command prompt and navigate to {IQ Bot Installation
 Directory}\Configurations

b) Esegui il comando seguente: messagequeue_cluster_configuration.bat
 “IQBotCluster1”.

4. Collega il secondo cluster al cluster primario.
a) In IQBotCluster2 VM, open command prompt and navigate to {IQ Bot Installation

 Directory}\Configurations.
b) Esegui il comando seguente: messagequeue_cluster_configuration.bat

 “IQBotCluster1”.

5. Verifica che i cluster siano stati aggiunti correttamente.
Open command prompt, navigate to {RabbitMq installation directory}\sbin and execute
the following command: rabbitmqctl.bat cluster_status.
You should see a similar output to the following, confirming that the two clusters were successfully
added: Cluster status of node rabbit @IQBotCluster2...[{ nodes, [{ disc,
 [rabbit @IQBotCluster1, rabbit @IQBotCluster2] }] }, { running_nodes,
 [rabbit @IQBotCluster1, rabbit @IQBotCluster2] }, { cluster_name, <<
 "rabbit@IQBotCluster1" >> }, { partitions, [] }, { alarms, [{ rabbit
 @IQBotCluster1, [] }, { rabbit @IQBotCluster2, [] }] }]
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6. Collega il terzo cluster al cluster primario.
a) In IQBotCluster3 VM, open command prompt and navigate to {IQ Bot Installation

 Directory}\Configurations.
b) Esegui il comando seguente: messagequeue_cluster_configuration.bat

 “IQBotCluster1”.

You should see a similar output to the following, confirming that the third cluster was
successfully added: Cluster status of node rabbit @IQBotCluster3...[{ nodes,
 [{ disc, [rabbit @IQBotCluster1, rabbit @IQBotCluster2, rabbit
 @IQBotCluster3] }] }, { running_nodes, [rabbit @IQBotCluster1,
 rabbit @IQBotCluster2, rabbit @IQBotCluster3] }, { cluster_name, <<
 "rabbit@IQBotCluster1" >> }, { partitions, [] }, { alarms, [{ rabbit
 @IQBotCluster1, [] }, { rabbit @IQBotCluster2, [] }, { rabbit
 @IQBotCluster3, [] }] }]

Una volta completato il collegamento dei cluster, vai al passaggio 4 in Installazione di IQ Bot in modalità
cluster alla pagina 1083.

Come rendere accessibile una cartella condivisa
Share the output folder with all the devices on the cluster so that when IQ Bot processes documents, the
extracted data is saved to the one output folder.
Segui questa procedura per rendere la cartella condivisa accessibile a IQ Bot.
1. Change log on of the application services with .\Administrator account on all cluster nodes.
2. Sul nodo primario (cartella condivisa), modifica le seguenti impostazioni:

a) Fai clic su Pannello di controllo > Rete e Internet > Centro connessioni di rete e
condivisione > Impostazione condivisione avanzata

b) Espandi Privato e fai clic su Individuazione rete.
c) In Individuazione rete:

1. Seleziona Attiva individuazione rete.
2. Seleziona la casella di controllo Attiva la configurazione automatica dei dispositivi

connessi alla rete.
3. Fai clic su Condivisione file e stampanti, quindi seleziona la casella di controllo Attiva

condivisione file e stampanti.

d) Espandi Guest o Pubblico e fai clic su Individuazione rete.
e) In Individuazione rete:

1. Seleziona Attiva individuazione rete.
2. Fai clic su Condivisione file e stampanti, quindi seleziona la casella di controllo Attiva

condivisione file e stampanti.

Apri "Editor Criteri di gruppo locali". Accedi a Criteri del computer locale >> Impostazioni di
Windows >> Impostazioni di sicurezza >> Criteri locali >> Opzioni di sicurezza. Individua
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"Accesso di rete: modello di condivisione e sicurezza per gli account locali”. Modificalo in "Solo
Guest: gli utenti locali effettuano l'autenticazione come Guest".

f) Fai clic su Editor criteri di gruppo locali.
g) Fai clic su Criteri del computer locale > Impostazioni di Windows > Impostazioni di

sicurezza > Criteri locali > Opzioni di sicurezza.
h) Trova Accesso alla rete: Modello di condivisione e sicurezza per gli account locali e

modificalo in Solo Guest: gli utenti locali effettuano l'autenticazione come
 Guest.

i) Esegui questo script Powershell:
Set-ItemProperty -Path "HKLM:\SYSTEM\CurrentControlSet\Services
\LanmanWorkstation\Parameters" -Name "AllowInsecureGuestAuth" -Type
 DWord -Value 1

È necessario eseguire questo script Powershell su ogni macchina che fa parte del cluster.

After you have made the shared folder accessible to every device in the cluster, proceed to step 3 in
Installazione di IQ Bot in modalità cluster alla pagina 1083.

Installazione di IQ Bot in modalità Cluster su Amazon EC2
Installare IQ Bot in modalità cluster su Amazon Elastic Compute Cloud (Amazon EC2).
Se installi IQ Bot in modalità Cluster su Amazon EC2, prendi nota di quanto segue.
• The name for the Amazon EC2 RabbitMQ v3.8.18cluster is in this format: rabbit@ip-XXX-XXX-XX-

XX.
• La connessione a un nodo funziona se entrambi i nodi si trovano nella stessa rete locale. Se ti connetti a

un cluster al di fuori della rete Amazon EC2 locale, configura il file host del nodo 2.
• Add an entry in the host file where AA.AA.AAA.AAA is the public IP of node 1.

AA.AA.AAA.AAA
ip-XXX-XX-XX-XX

If all the IQ Bot instances in a cluster are not a part of the same domain, ensure that the following services
are running using the Administrator user login on each instance.
• Automation Anywhere Cognitive Projects
• Automation Anywhere Cognitive Validator
• Automation Anywhere Cognitive File Manager

Per eseguire un servizio utilizzando l'accesso come utente Admin, effettua la seguente procedura.
1. Click Task Manager > Services > Open Services.
2. Fai clic con il pulsante destro del mouse sul servizio di destinazione, ad esempio Automation

AnywhereProgetti cognitivi, quindi fai clic su Proprietà.
3. Nella finestra di dialogo Proprietà, seleziona Questo account e immetti le credenziali per l'utente

amministratore.
4. Fai clic su OK e riavvia il servizio. Ripeti questa procedura per i servizi rimanenti in questa istanza e

tutte le altre istanze di IQ Bot nel cluster.

© 2023 Automation Anywhere. All rights reserved.     1087



    Automation Anywhere - Installazione e aggiornamento Automation 360

Lista di controllo post-installazione
Verifica che sia installato il IQ Bot, che i servizi IQ Bot siano in esecuzione utilizzando le API di controllo
dell'integrità e registra il IQ Bot con la Control Room.

Passaggio 1: Verifica di IQ Bot nel pannello di
controllo

Verifica che l'elemento Automation Anywhere
IQ Bot sia presente in Pannello di controllo >
Programmi > Programmi e funzionalità del
computer in cui IQ Bot è installato.

Passaggio 2: Conferma che i servizi cognitivi
Automation Anywhere siano in esecuzione

Assicurati che i seguenti servizi siano installati sul
computer in cui IQ Bot è installato e che lo stato
dei servizi sia impostato su In esecuzione nella
finestra dei servizi di Microsoft Windows.
Per visualizzare l'elenco dei servizi attualmente in
esecuzione, apri services.msc utilizzando Start >
Esegui.
• Automation Anywhere Cognitive Alias
• Automation Anywhere Cognitive Application
• Automation Anywhere Cognitive Classifier

Service
• Automation Anywhere Cognitive Console
• Automation Anywhere Cognitive File Manager
• Automation Anywhere Cognitive Gateway-2
• Automation Anywhere Cognitive MLScheduler

Service

Nota:  A partire dalla versione Build 12350,
questo servizio è disabilitato per impostazione
predefinita.

• Automation Anywhere Cognitive MLWeb Service

Nota:  A partire dalla versione Build 12350,
questo servizio utilizza un nuovo modello per
rilevare meglio le caselle di controllo e le tabelle.
Per tornare al modello precedente, apri il file
CognitiveServiceConfiguration.json, individua
il seguente frammento di codice e aggiorna il
parametro version a v1:

"MLWebService": {
"port": "9991",
"version": "v2"
}

• Automation Anywhere Cognitive Projects
• Automation Anywhere Cognitive Report
• Automation Anywhere Cognitive Validator
• Automation Anywhere Cognitive Visionbot

Manager
• Automation Anywhere Cognitive VisionbotEngine

Service
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Per reinstallare i servizi IQ Bot, esegui reinstall-
allservices.bat come amministratore dalla cartella
di configurazione > directory di installazione
di IQ Bot. Verrà visualizzato un elenco dei servizi
con i numeri di serie. Esegui una delle seguenti
operazioni per reinstallare i servizi:
1. Immetti il numero di serie del servizio che

desideri reinstallare.

2. Immetti il numero di serie del servizio seguito
dal nome utente e dalla password del dominio.

Passaggio 3: Esecuzione di un controllo
dell'integrità

Utilizza l'API di controllo dell'integrità per verificare
il servizio richiesto. I dettagli della richiesta/risposta

© 2023 Automation Anywhere. All rights reserved.     1089



    Automation Anywhere - Installazione e aggiornamento Automation 360

dell'API di controllo dell'integrità sono descritti nella
seguente tabella.
Richieste
Nella tabella seguente sono elencate le richieste API
inviate per eseguire un controllo dell'integrità dei
diversi servizi IQ Bot:

Nome servizio URL

Alias http://<hostname/
IP>:9997/
healthcheck

Application
 Service

http://<hostname/
IP>:9002/
healthcheck

Project Service http://<hostname/
IP>:9999/
healthcheck

FileManager
 Service

http://<hostname/
IP>:9996/
healthcheck

Visionbot http://<hostname/
IP>:9998/
healthcheck

Validator Service http://<hostname/
IP>:9995/
healthcheck

Report Service http://<hostname/
IP>:9992/
healthcheck

Gateway Service http://<hostname/
IP>:8100/
healthcheck

Frontend or
 Console Service

http://<hostname/
IP>:3000/
healthcheck

MLWeb Service http://<hostname/
IP>:9991/
healthcheck

Nell'elenco della tabella, sostituisci <hostname/
IP> con il nome host/indirizzo IP di IQ Bot per
creare la richiesta API di controllo dell'integrità
utilizzando un browser Web sul computer su cui è
installato IQ Bot.
Ad esempio, se IQ Bot è accessibile all'indirizzo
http://localhost:3000, è possibile accedere al
controllo dell'integrità di FileManager utilizzando
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questo URL: http://localhost:9996/
healthcheck.
Risposte
Una tipica risposta di operazione completata è
illustrata nel seguente esempio di codice:
Subsystem

Application: <Service Name>

Status: OK

Application uptime: 0d 3h 45m 6s

Version: 1.2.0-RELEASE

Branch: RC-5.2-1

GIT #:
 d88e59c0435c3a836bb47cd586081205564904c5

Build Time: 2018-02-17T09:26:52.523Z

Dependencies:

Database Connectivity: OK

MessageQueue Connectivity: OK

Project: OK

VisionBot: OK

**<Service Name> potrebbe essere Alias,
Application, FileManager, Project, Report, Gateway,
Validator o VisionBot.
Dependencies: elenca lo stato di tutti i servizi
dipendenti, ad esempio il database e la coda dei
messaggi del servizio ispezionato.
Se l'API risponde con Status: Not_OK, vedi
Healthcheck status Not_Ok (A-People login required).

Passaggio 4: Verifica del database Il sistema crea il database IQBot.
Accedi al database utilizzando <dbusername> e
<dbpasswd> per verificare i nomi dei database
e delle tabelle utilizzando <hostname>,
<dbusername>e <dbpasswd>.

Passaggio 5 (facoltativo): Creazione dei
certificati appropriati e configurazione delle
impostazioni HTTP e HTTPS

Creazione di un certificato autofirmato con il nome
alternativo del soggetto alla pagina 1092
Configurazione di IQ Bot con HTTP e HTTPS alla
pagina 1095

Passaggio 6: Registrati È necessario registrare IQ Bot con Control Room
prima di poter iniziare a utilizzare IQ Bot.
Registrazione di IQ Bot con Control Room alla pagina
1094
Se la registrazione non riesce:
per risolvere il problema, procedi come indicato
nelle pagine seguenti:
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1. Annullamento della registrazione di IQ Bot da
Control Room alla pagina 1109

2. Risoluzione dell'errore di registrazione di IQ Bot
alla pagina 1108

Avanti: Installazione di un motore OCR (facoltativa):
Durante l'installazione di IQ Bot, il sistema imposta
la versione di Tesseract Optical Character Reader
più recente come motore OCR predefinito. Per
utilizzare un motore diverso, procedi nel modo
descritto nel relativo collegamento:
Utilizzare Microsoft Azure Computer Vision OCR engine
alla pagina 1098
Utilizzo del motore ABBYY FineReader Engine OCR in
IQ Bot alla pagina 1101
Utilizzo del motore Google Vision API OCR alla pagina
1104
Utilizzo del motore Tegaki API OCR alla pagina 1107
Effettua l'accesso e imposta la Control Room:
crea e registra utenti specifici IQ Bot nella Control
Room. Ulteriori informazioni sui ruoli e sulle
autorizzazioni di accesso di IQ Bot: IQ Bot user
personas and roles alla pagina 2476

Concetti correlati
Installazione e aggiornamento Automation 360 IQ Bot alla pagina 1066
This collection of topics guide you through the process of installing or setting up Automation 360 IQ Bot
On-Premises and Cloud.

Creazione di un certificato autofirmato con il nome alternativo del soggetto
Puoi creare un certificato autofirmato con il nome alternativo del soggetto (Subject Alternative Name, SAN)
quando desideri utilizzare un certificato SSL per più domini.
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1. Crea un file con il nome domain.cnf e aggiungi la seguente configurazione in base alle tue esigenze:
[req]

default_bits = 2048

prompt = no

default_md = sha256

x509_extensions = v3_req

distinguished_name = dn

[dn]

C = ES

ST = MyState

L = MyCity

O = MyOrg

emailAddress = email@mydomain.com (Any email address)

CN = sss-laptop136.aaspl-brd.com (CR FQDN Url Name)

[v3_req]

subjectAltName = @alt_names

[alt_names]

DNS.1 = sss-laptop136.aaspl-brd.com (CR FQDN Url Name)

DNS.2 = sss-laptop151.aaspl-brd.com (IQBOT URL FQDN Name)

2. Scarica l'utilità Openssl.
3. Puoi creare il certificato in Microsoft Windows o in Linux:

• Esegui il seguente comando per creare il certificato in Microsoft Windows:

openssl.exe req -new -x509 -newkey rsa:2048 -sha256 -nodes -keyout
"D:\ssc\ssc\key.key" -days 3560 -out "D:\ssc\ssc\cert.crt" -config
"D:\ssc\ssc\domain.cnf"

• Esegui il seguente comando per creare il certificato in Linux:

openssl req -new -x509 -newkey rsa:2048 -sha256 -nodes -keyout /tmp/
cert/key.key -days 3560
-out /tmp/cert/cert.crt -config /tmp/cert/domain.cnf

4. Crea il file .pfx dal file del certificato e dal file della chiave:
• Esegui il seguente comando per creare il file .pfx dal file del certificato e dal file della chiave in

Microsoft Windows:

openssl.exe pkcs12 -export -out "D:\ssc\ssc\sss-aspl.pfx" -inkey "D:
\ssc\ssc\key.key"
-in "D:\ssc\ssc\cert.crt"

• Esegui il seguente comando per creare il file .pfx dal file del certificato e dal file della chiave in
Linux:

openssl.exe pkcs12 -export -out /tmp/cert/sss-aspl.pfx -inkey /tmp/
cert/key.key -in
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/tmp/cert/cert.crt"

5. Importa il file .pfx in Microsoft IIS.
Utilizza lo stesso file .pfx con l'installazione di IQ Bot.

6. Esegui il comando seguente per importare il certificato nell'archivio chiavi Java:

keytool.exe -import -alias dev -keystore "C:\Program Files
(x86)\Java\jre1.8.0_91\lib\security\cacerts" -file "D:\cert\xyz.com.crt"

Based on the type of operating system 32-bit / 64-bit, this C:\Program Files (x86)\Java
\jre1.8.0_91\lib\security\cacerts directory can differ.
Se il certificato non viene importato nell'archivio chiavi Java, Control Room visualizzerà il seguente
messaggio di errore: Controllo firma di validator percorso del certificato di
 sicurezza Java non riuscito.

7. Accedi a %installation_dir%\Configurations ed esegui
stopanduninstallallservices.bat come amministratore.

8. Accedi a %installation_dir%\Configurations ed esegui installandstartervices.bat
come amministratore.

9. Importa il file cert.crt nella radice attendibile utilizzando Microsoft Management Console (MMC).

Concetti correlati
Installazione e aggiornamento Automation 360 IQ Bot alla pagina 1066
This collection of topics guide you through the process of installing or setting up Automation 360 IQ Bot
On-Premises and Cloud.

Registrazione di IQ Bot con Control Room
IQ Bot è integrato con Control Room per la gestione degli utenti. Accedi a Control Room e registra IQ Bot.
Prima di registrare IQ Bot con Control Room, completa le operazioni seguenti:
• Avvia Control Room e crea un utente Admin.
• Installa la licenza per IQ Bot. Consulta Configure new licenses.

IQ Bot è accessibile dopo la registrazione con Control Room.

Nota:  Annota le credenziali del database utilizzate per l'installazione di Control Room. Questo è necessario
per l'installazione di IQ Bot se stai utilizzando lo stesso database.

1. Accedi a Control Room come amministratore.
Se hai già effettuato l'accesso a Control Room nella stessa sessione del browser, accederai
automaticamente a IQ Bot.

2. Fai clic su Amministrazione > Impostazioni > IQ Bot.
3. Fai clic su Modifica nella sezione IQ Bot per visualizzare una casella di testo.
4. Immetti l'URL corretto di IQ Bot, ad esempio http(s)://IQBotURL/ e fai clic su Salva modifiche.

Se la registrazione dell'applicazione non riesce, prova a registrare nuovamente l'applicazione.

Nota:  The URL https://{CR_URL}/IQBot/ is case-sensitive. For example, ensure that the URL
mentions "IQBot" and not "IQbot".
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Configurazione di IQ Bot con HTTP e HTTPS
In questa sezione vengono descritti scenari di dominio singoli e multipli che possono presentarsi durante
l'installazione di IQ Bot e di Control Room con vari certificati server.
Esistono due scenari principali:
• Installazione di IQ Bot e di Control Room con certificati server con caratteri jolly (dominio singolo).
• Installazione di IQ Bot e di Control Room con singoli certificati server (domini diversi).

Puoi crittografare la comunicazione tra IQ Bot e Control Room configurando SSL bidirezionale (in modo
reciproco). La procedura seguente illustra come configurare questo comportamento che può essere
ottenuto scambiando i certificati SSL tra IQ Bot e Control Room.

Nota:  IQ Bot non supporta il certificato autofirmato.

Prerequisito per dominio singolo
Se Control Room e IQ Bot si trovano in un singolo dominio e questo viene denominato DomainOne, sono
necessari i seguenti file di certificato:
• PFX file:

Assicurati di disporre del file DomainOne.pfx. La dimensione del file è di circa 7/8 KB. È necessario un
file pfx per un singolo dominio.

• Certificato CA fornito in bundle dalla Control Room Enterprise (con tutte le informazioni sui
certificati intermedi):
Utilizza qualsiasi strumento per creare il certificato in bundle oppure utilizza openssl per creare un
certificato CA/in bundle dal file DomainOne.pfx.
Utilizza il seguente comando di esempio per creare un certificato CA/in bundle utilizzando openssl per
DomainOne.pfx:

openssl.exe pkcs12 -in "{DomainOne.pfx file location}" -cacerts -nokeys -
chain -out "
{Outputlocation}\DomainOne_ControlRoom_CA.crt

Nota:  Sarà necessario il certificato in bundle di Control Room per uno o più domini.

• Certificati pubblici da IQ Bot e Control Room:
Utilizza qualsiasi strumento per creare i certificati pubblici o openssl per creare un certificato pubblico dal
file DomainOne.pfx.
Utilizza il seguente comando di esempio per creare il certificato pubblico utilizzando openssl per
DomainOne.pfx:

openssl.exe pkcs12 -in "{DomainOne.pfx file location}" -clcerts -nokeys -
out
"{Outputlocation}\DomainOne_ControlRoom_PublicCertificate.crt

Nota:  Per un singolo dominio, sarà disponibile un certificato pubblico per entrambi, IQ Bot e Control
Room.

Prerequisito per domini multipli
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Se Control Room e IQ Bot si trovano in domini separati e i nomi di dominio sono DomainOne (Control
Room) e DomainTwo (IQ Bot), sono necessari i seguenti file di certificato:
• File pfx:

Assicurati di disporre dei file DomainOne.pfx e DomainTwo.pfx. La dimensione del file è di circa 7/8
KB.

• Certificati pubblici da IQ Bot e Control Room:
Utilizza qualsiasi strumento per creare il certificato in bundle o openssl per creare il certificato pubblico
dal file DomainTwo.pfx.
Utilizza il seguente comando di esempio per creare il certificato pubblico utilizzando openssl per
DomainTwo.pfx:

openssl.exe pkcs12 -in "{DomainTwo.pfx file location}" -clcerts -nokeys -
out
"{Outputlocation}\DomainTwo_IQBot_PublicCertificate.crt

Nota:  : Se hai impostato Control Room o IQ Bot con HTTPS, configura IQ Bot con HTTPS prima della
registrazione.

Configurazione di IQ Bot con HTTPS quando Control Room è configurato con HTTP
Configura IQ Bot con HTTPS quando Control Room è configurata con HTTP.
1. Configura IQ Bot tramite il file PFX con configurazione HTTPS durante l'installazione.
2. Inserisci il certificato in bundle (DomainTwo_IQBot_CA.crt) per Control Room nella cartella IQ Bot,

dopo l'installazione di IQ Bot in C: \Program Files (x86)\Automation Anywhere IQ Bot
\Portal\keys. Rinomina DomainTwo_IQBot_CA.crt in ca.crt.

Importante:  Se il file ca.crt nella cartella C:\Program Files (x86)\Automation
 Anywhere IQ Bot <version number>\Portal\keys è già presente, sostituiscilo con il nuovo
file ca.crt.

3. Aggiungi il certificato pubblico di IQ Bot (DomainTwo_IQBot_PublicCertificate.crt) all'archivio chiavi per
la Control Room eseguendo il comando riportato di seguito come amministratore di sistema:

"{Control Room installation directory}\JRE\bin\java.exe" -jar certmgr.jar
 -appDir "{Control Room
installation directory}" -importTrustCert "{FolderLocation}/
DomainTwo_IQBot_PublicCertificate.crt" 

Configurazione di IQ Bot con HTTP quando Control Room è configurato con HTTPS
Puoi configurare IQ Bot con HTTP e HTTPS in modo da potervi accedere utilizzando HTTPS e HTTP nel
relativo URL.
1. Inserisci il certificato in bundle (DomainOne_ControlRoom_CA.crt) per Control Room nella cartella IQ

Bot dopo l'installazione di IQ Bot in C: \Program Files (x86)\Automation Anywhere IQ
 Bot\Portal\keys. Rinomina ControlRoom_CA.crt in ca.crt.

Importante:  Se il file ca.crt nella cartella C:\Program Files (x86)\Automation
 Anywhere IQ Bot <version number>\Portal\keys è già presente, sostituiscilo con il nuovo
file ca.crt.
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2. Aggiungi il certificato pubblico di Control Room (DomainOne_ControlRoom_PublicCertificate.crt)
all'archivio chiavi per IQ Bot eseguendo il comando riportato di seguito come amministratore di
sistema:

"{IQ Bot installation directory}\JRE\zulu8.40.0.20-sa-fx-jre8.0.222-
win_x64\bin\keytool.exe" -import -
alias cr -keystore "{IQ Bot installation directory}\JRE\zulu8.40.0.20-sa-
fx-jre8.0.222-
in_x64\lib\security\cacerts" -file "{FolderLocation}/
 DomainOne_ControlRoom_PublicCertificate.crt "

The system will ask for a keystore password, which is changeit.

Nota:  Sometimes the system shows a message saying cr exists. In this case, change cr in the
command to cr1 or something else.

Configurazione di IQ Bot con HTTPS utilizzando un singolo dominio
Puoi configurare IQ Bot con HTTPS quando Control Room è configurato con HTTPS utilizzando un singolo
dominio.
1. Installa IQ Bot utilizzando il file PFX con la configurazione HTTPS durante l'installazione.
2. Inserisci il certificato in bundle (DomainOne_ControlRoom_CA.crt) per Control Room nella cartella IQ

Bot dopo l'installazione di IQ Bot in C:\Program Files (x86)\Automation Anywhere IQ Bot
 <version number>\Portal\keys. Rinomina DomainOne ControlRoom_CA.crt in ca.crt.

Importante:
Se il file ca.crt nella cartella C:\Program Files (x86)\Automation Anywhere IQ Bot
 <version number>\Portal\keys è già presente, sostituiscilo con il nuovo file ca.crt.

3. Aggiungi il certificato pubblico di Control Room (DomainOne_ControlRoom_PublicCertificate.crt)
all'archivio chiavi per IQ Bot eseguendo questo comando come amministratore di sistema:

"{IQ Bot installation directory}\JRE\zulu8.40.0.20-sa-fx-jre8.0.222-
win_x64\bin\keytool.exe"
-import -alias cr -keystore "{IQ Bot installation directory}\JRE
\zulu8.40.0.20-sa-fx-jre8.0.222-
win_x64\lib\security\cacerts" -file "{FolderLocation}/
 DomainOne_ControlRoom_PublicCertificate.crt "

.
The system will ask for a keystore password, which is changeit.

Nota:  Sometimes the system shows a message saying cr exists. In this case, change cr in the
command to cr1 or something else.

Concetti correlati
Naming guidelines for Control Room URLs alla pagina 977
Adhere to Domain Name System (DNS) guidelines when you configure domain and subdomain Control
Room URLs for On-Premises and Cloud deployments.

Configurazione di IQ Bot con HTTPS utilizzando più domini
Puoi configurare IQ Bot con HTTPS quando Control Room è configurato con HTTP utilizzando più domini.
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1. Configura IQ Bot utilizzando il file PFX con la configurazione HTTPS durante l'installazione.
2. Inserisci il certificato in bundle (DomainOne_ControlRoom_CA.crt) per Control Room nella cartella IQ

Bot dopo l'installazione di IQ Bot in: C: \Program Files (x86)\Automation Anywhere IQ
 Bot\Portal\keys.
Rinomina DomainOne ControlRoom_CA.crt in ca.crt.

Importante:  Se il file ca.crt nella cartella C:\Program Files (x86)\Automation
 Anywhere IQ Bot <version number>\Portal\keys è già presente, sostituiscilo con il nuovo
file ca.crt.

3. Aggiungi il certificato pubblico di Control Room (DomainOne_ControlRoom_PublicCertificate.crt)
all'archivio chiavi per IQ Bot eseguendo il comando riportato di seguito come amministratore di
sistema:

"{IQ Bot installation directory}\JRE\zulu8.40.0.20-sa-fx-jre8.0.222-
win_x64\bin\keytool.exe" -import -
alias cr -keystore "{IQ Bot installation directory}\JRE\zulu8.40.0.20-sa-
fx-jre8.0.222-
in_x64\lib\security\cacerts" -file "{FolderLocation}/
 DomainOne_ControlRoom_PublicCertificate.crt "

The system will ask for a keystore password, which is changeit.

Nota:  Sometimes the system shows a message saying cr exists. In this case, change cr in the
command to cr1 or something else.

4. Aggiungi il certificato pubblico di IQ Bot (DomainTwo_IQBot_PublicCertificate.crt) all'archivio chiavi per
la Control Room eseguendo il comando riportato di seguito come amministratore di sistema:

"{Control Room installation directory}\JRE\bin\java.exe" -jar certmgr.jar
 -appDir "{Control Room 
installation directory}" -importTrustCert "{FolderLocation}/
DomainTwo_IQBot_PublicCertificate.crt"

Nota:  Per Automation 360 IQ Bot (Build 550), cambia JRE in jrk nel comando menzionato sopra.

5. Dopodiché, riavvia le macchine e segui le istruzioni per registrare IQ Bot.
Vedi Registrazione di IQ Bot con Control Room alla pagina 1094

Utilizzare Microsoft Azure Computer Vision OCR engine
Microsoft Azure Computer Vision OCR engine è un motore OCR cloud ed è disponibile per tutti i clienti di IQ
Bot. IQ Bot automatizza alcuni passaggi dell'installazione per Microsoft Azure Computer Vision OCR engine.
When you process documents using the Microsoft Azure Computer Vision OCR engine, data is removed
immediately. Microsoft Azure Computer Vision OCR engine fornisce circa il 18% di STP e l'80% di
precisione con l'estrazione dei dati. For more information on privacy for data retention, see Microsoft Azure
Cognitive Services.

Nota:  IQ Bot also supports containerized deployment of Microsoft Azure Computer Vision OCR engine:
Configure IQ Bot using Docker container and Azure OCR (A-People login required)
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When creating a learning instance, you can select any language from the Primary language of
documents drop-down menu. During processing, the OCR engine tries to auto-detect the primary
language and can override your selection. For example, you can specify English, but if you upload a
Spanish document, the API will try to process the Spanish language.

Suggerimento:  You can troubleshoot any issues with extracting data from low quality or handwritten
documents IQ Bot unable to extract data from low quality and Handwritten documents (A-People login required)

Segui la procedura per configurare il file Settings.txt e utilizzare Microsoft Azure Computer Vision OCR
engine.

Importante:  La configurazione del file settings.txt non è applicabile a Automation 360 IQ Bot Cloud

1. Assicurati che il server IQ Bot disponga di connettività Internet e della risoluzione esterna del DNS.
Check to enable communication for the API endpoint on default port = 443: default endpoint =
 https://aai-iq-bot-ocr.cognitiveservices.azure.com/.

Nota:  To validate connectivity to the API endpoint and the server, open a web browser on the server
and type in the complete URL for the API endpoint. If the browser returns a 404 error, then it implies
that a response from the API endpoint was received.

2. Puoi utilizzare le tue chiavi di sottoscrizione o di controllo ortografico Microsoft Azure Computer Vision
OCR engine. Per ulteriori informazioni, vedi Utilizzo delle chiavi personali per Microsoft Azure Computer
Vision OCR engine alla pagina 1099.

3. Opzionale: From the C:\Program Files (x86)\Automation 360 IQ Bot <version
 number>\Configurations folder, open the Settings.txt file, and change the OCR engine
value to OCREngine=Tesseract4 or OCREngine=Abbyy to OCREngine=MicrosoftAzureAPI.
Quindi, salva il file.

4. Esegui il file stopanduninstallallservices.bat in C:\Program Files (x86)\Automation 360
 IQ Bot\Configurations.
Dopo aver arrestato i servizi, esegui il file installandstartallservices.bat per installare e avviare i
servizi.

5. Create learning instances in IQ Bot, and use Microsoft Azure Computer Vision OCR engine for the text
segmentation, and OCR engine for these learning instances.
For these learning instances, you can continue to use the IQ Bot capabilities for document
classification, auto-mapped fields, cognitive extraction, and field value auto-correction.

Elenco degli URL di servizio utilizzati per Microsoft Azure Computer Vision OCR engine
(facoltativo)
• https://aai-iq-bot-ocr.cognitiveservices.azure.com/
• https://aai-iq-bot-ocr-spellcheck.cognitiveservices.azure.com/

Nota:  All URLs point to a global service region in United States.

If IQ Bot is unable to process a document using Microsoft Azure Computer Vision OCR engine, you can
review the troubleshooting tips.
IQ Bot unable to process the document with Microsoft Azure OCR (A-People login required)

Utilizzo delle chiavi personali per Microsoft Azure Computer Vision OCR engine
Puoi utilizzare le tue chiavi di sottoscrizione o di controllo ortografico Microsoft Azure Computer Vision OCR
engine.

© 2023 Automation Anywhere. All rights reserved.     1099

https://apeople.automationanywhere.com/s/article/IQBot-unable-to-extract-data-from-Low-quality-and-Handwritten-documents
https://apeople.automationanywhere.com/s/article/IQbot-unable-to-process-the-document-with-Microsoft-Azure-OCR


    Automation Anywhere - Installazione e aggiornamento Automation 360

Gli utenti possono utilizzare una combinazione delle proprie chiavi di Microsoft Azure Computer Vision
OCR engine con le chiavi di controllo ortografico fornite da Automation Anywhere. L'utilizzo delle chiavi di
controllo ortografico fornite da Automation Anywhere consentirà di inviare i dati all'account Automation
Anywhere. If you do not want to send any data to the Automation Anywhere Microsoft Azure account,
you would have to provide your own Spell Check service keys, or turn it off by setting the value in the
AzureOCREngineSettings.json file to EnableAutoCorrectSegmentText: false.
Completa la procedura riportata di seguito per utilizzare le tue chiavi per Microsoft Azure Computer Vision
OCR engine.
1. Per impostazione predefinita, vengono utilizzate le chiavi crittografate di sottoscrizione e di controllo

ortografico di Microsoft Azure Computer Vision OCR engine di IQ Bot. If you prefer to use your
own Microsoft Azure Computer Vision OCR engine subscription and, or Spell Check keys, go to C:
\Program Files (x86)\Automation Anywhere IQ Bot <version>\Configurationsand
folder Configurations > AzureOCREngineSettings.json file, and specify your keys.
Se vengono specificate entrambe le chiavi SubscriptionKey e SubscriptionClientKey, verrà
utilizzata la chiave SubscriptionClientKey:
• VisionSubscriptionKey
• VisionSubscriptionClientKey
• SpellCheckSubscriptionKey
• SpellCheckSubscriptionClientKey

2. Inserisci le tue chiavi correttamente per assicurare le chiamate API corrette nel modo seguente:
Prima:

{
  "VisionServiceUrl": "https://aai-iq-bot-
ocr.cognitiveservices.azure.com/",
  "EngineType": 0,
  "VisionSubscriptionKey": "",
  "VisionSubscriptionClientKey": "",
  "SpellCheckSubscriptionKey": "",
  "SpellCheckSubscriptionClientKey": "",
  "EnableDebugging": false,
  "DebuggingFolder": "C:\\Users\\Public\\Documents\\Automation Anywhere
 IQBot Platform\\Output\\Engine\\Azure",
  "HttpTimeoutInSec": 300,
  "EnableReprocessLowConfidentSegment": true,
  "EnableAutoCorrectSegmentText": true,
  "EnableResolveOverlappedSegment": true,
  "EnableFieldMerging": true,
  "EnableFieldRegions": true
}

Dopo:

{
  "VisionServiceUrl": "https://aai-iq-bot-
ocr.cognitiveservices.azure.com/",
  "EngineType": 0,
  "VisionSubscriptionKey": "",
  "VisionSubscriptionClientKey": "191234d5e7abc1f382123459d4399e33",
  "SpellCheckSubscriptionKey": "",
  "SpellCheckSubscriptionClientKey": "336f8f6a503a4c30ba123456834d4abc",
  "EnableDebugging": false,
  "DebuggingFolder": "C:\\Users\\Public\\Documents\\Automation Anywhere
 IQBot Platform\\Output\\Engine\\Azure",
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  "HttpTimeoutInSec": 300,
  "EnableReprocessLowConfidentSegment": true,
  "EnableAutoCorrectSegmentText": true,
  "EnableResolveOverlappedSegment": true,
  "EnableFieldMerging": true,
  "EnableFieldRegions": true
}

3. Esegui il file stopanduninstallallservices.bat come amministratore. Il percorso predefinito
del file è C:\Program Files (x86)\Automation Anywhere IQ Bot <version>
\Configurations.

4. Esegui il file installandstartallservices.bat come amministratore. Il percorso predefinito
del file è C:\Program Files (x86)\Automation Anywhere IQ Bot <version>
\Configurations .
Accedi alla tua pagina Web o aggiornala IQ Bot.

Utilizzo del motore ABBYY FineReader Engine OCR in IQ Bot
IQ Bot supports ABBYY FineReader Engine version 12.2, 12.3, and 12.4.
Durante l'installazione di IQ Bot, il sistema installa automaticamente sul server una licenza run-time aperta
ABBYY FineReader Engine.

Nota:  If you have completed the steps to upgrade IQ Bot, you must update the folder path to the
AbbyyOCREngineSettings.json configuration file.

Per eseguire manualmente l'installazione di ABBYY FineReader Engine, procedi nel modo seguente:
1. Scarica il plug-in OCR con IQ Bot.
2. Unzip the OCR plug-in folder in your downloads folder, and place that unzipped folder, at <IQ Bot

 Installation Path>\Automation 360 IQ Bot\.
3. Ensure the folder says <IQ Bot Installation Path>\Automation 360 IQ Bot\OCR

 Plugins\ABBYY SDK\12\FineReader Engine. . ., and the unzipping does not create OCR
 Plugins\OCR Plugins twice. After you unzip the downloaded file, make sure to keep the folder
name as OCR Plugins, and remove the version number. Ad esempio: If the unzipped folder name is
OCR Plugins 12.4, remove the version number (12.4) from the end of the folder name.

4. Per utilizzare ABBYY FineReader Engine con IQ Bot hai le seguenti opzioni:
Opzioni Descrizione

Impostare ABBYY FineReader Engine come
motore OCR predefinito

Configura il file Settings.txt.
Segui i passaggi 5 e 6 per configurare il file
Settings.txt.

Importante:  La configurazione del file
settings.txt non è applicabile a Automation
360 IQ Bot Cloud

Seleziona il motore ABBYY FineReader
Engine OCR dall'interfaccia utente

Per effettuare la selezione dall'interfaccia utente,
vedi Selezione di un motore OCR alla pagina 2490.
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5. Importante:  La configurazione del file settings.txt non è applicabile a Automation 360 IQ Bot
Cloud.
In Automation 360 IQ Bot Cloud, è possibile utilizzare l'API appConfigurations per leggere e
aggiornare le impostazioni OCR.
Per assistenza per l'utilizzo delle API, contatta il team di supporto. Open a support case (A-People login
required)

Per impostare ABBYY FineReader Engine come motore OCR predefinito, dalla cartella C:\Program
 Files (x86)\Automation 360 IQ Bot <version>\Configurations, apri il file
Settings.txt , modifica OCREngine=Tesseract4 in OCREngine=Abbyy e salva il file.

Importante:  Risoluzione dei problemi di classificazione nell'elaborazione di documenti in lingua
cinese:
All files are getting unclassified while processing Chinese language documents (A-People login required)

6. Quindi, esegui il file stopanduninstallallservices.bat in C:\Program Files
 (x86)\Automation 360 IQ Bot\Configurations.

Nota:  Dopo aver arrestato i servizi, esegui il file installandstartallservices.bat per installare e
avviare i servizi.

7. Crea le istanze di apprendimento in IQ Bot e utilizza ABBYY FineReader Engine per la segmentazione
del testo, quindi il motore OCR per tali istanze. Al contempo, per queste istanze di apprendimento,
puoi ancora sfruttare le funzionalità di IQ Bot per classificare i documenti, mappare automaticamente
campi, effettuare l'estrazione cognitiva e correggere automaticamente il valore del campo.

Nota:  If you install IQ Bot in a different folder besides C:\Program Files
 (x86)\Automation 360 IQ Bot <version>, find and open the Configurations >
ABBYYOCREngineSettings.json folder, and update the embedded EnginePath and LicensePath to
match the different folder.

Ad esempio:

{
  "UseOpenRuntimeLicense": true,
  "EnginePath": "C:\\Program Files (x86)\\Automation 360 IQ Bot\\OCR
 Plugins\\ABBYY SDK\\12\\FineReader Engine\\Bin",
  "DeveloperSN": "",
  "ProjectId": "",
  "LicensePath": "C:\\Program Files (x86)\\Automation 360 IQ Bot\
\Configurations\\Runtime.ABBYY.LocalLicense",
  "LicensePassword": ""
}

Nota:  Talvolta non è possibile classificare i documenti con ABBYY FineReader Engine come motore
OCR. Vedi la soluzione consigliata per questo problema.
Document uploads are moving to unclassified state while using Abbyy OCR engine (A-People login required)

© 2023 Automation Anywhere. All rights reserved.     1102

https://apeople.automationanywhere.com/s/article/How-to-Open-a-Support-Case
https://apeople.automationanywhere.com/s/article/How-to-Open-a-Support-Case
https://apeople.automationanywhere.com/s/article/All-files-are-getting-unclassified-while-processing-Chinese-language-documents
https://apeople.automationanywhere.com/s/article/Document-uploads-are-moving-to-unclassified-state-while-using-Abbyy-OCR-engine


    Automation Anywhere - Installazione e aggiornamento Automation 360

8. The following table lists the various ABBYY FineReader Engine versions that are supported and
compatible with IQ Bot:

Tabella 2: Version compatibility matrix of ABBYY FineReader Engine and IQ Bot

Versione ABBYY FineReader Engine Versione IQ Bot

12.2 (A2019.12) and below

12.2 and 12.3 (A2019.13) to (A2019.16)

12.2, 12.3, and 12.4 (A2019.17) and later

Utilizzare la propria licenza di ABBYY FineReader Engine
Completa i passaggi per utilizzare la tua licenza ABBYY FineReader Engine.

1. Accedi alla cartella di configurazione  > della directory di installazione di IQ Bot e apri
AbbyyOCREngineSettings.json per aggiornare le seguenti proprietà:
• Modifica EnginePath e incolla il percorso del motore ABBYY FineReader Engine installato.

Ad esempio C:\\Program Files\\ABBYY SDK\\12\\FineReader Engine\\Bin.
Assicurati che il percorso includa separatori come le due barre rovesciate. Aggiorna la proprietà
DeveloperSN con la chiave di licenza.

• Aggiorna la proprietà ProjectId con l'ID del progetto di licenza.
• Aggiorna UseOpenRuntimeLicense a Falso.

2. Nella cartella C:\Program Files (x86)\Automation Anywhere IQ Bot <version>
\Configurations, apri il file Settings.txt per confermare o modificare OCREngine=ABBYY
FineReader Engine e salva il file.

3. Esegui il file stopanduninstallallservices in C:\Program Files (x86)\Automation
 Anywhere IQ Bot <version>\Configurations.

4. Esegui il file installandstartallservices e accedi alla o aggiorna la pagina web IQ Bot.

Procedura di installazione se ABBYY FineReader Engine rimane installato da una
versione di IQ Bot precedente
Se ABBYY FineReader Engine rimane installato da una versione di IQ Bot precedente, puoi utilizzare la
licenza del tempo di esecuzione aperta di IQ BotABBYY FineReader Engine.

1. Accedi alla cartella di configurazione  > della directory di installazione di IQ Bot e apri il file
AbbyyOCREngineSettings.json per aggiornare le seguenti proprietà:
Modifica EnginePath e incolla il percorso del motore ABBYY FineReader Engine installato. Ad
esempio C:\\Program Files\\ABBYY SDK\\12\\FineReader Engine\\Bin. Assicurati che il
percorso includa separatori come le due barre rovesciate.

2. Accedi alla directory di installazione di ABBYY FineReader Engine, apri la cartella Bin e rimuovi il file
Protection.Developer.dll.

3. Nella cartella C:\Program Files (x86)\Automation Anywhere IQ Bot <version>
\Configurations, apri il file Settings.txt, modifica o conferma OCREngine=ABBYY FineReader
Engine e salva il file.

4. Esegui il file stopanduninstallallservices in C:\Program Files (x86)\Automation
 Anywhere IQ Bot <version>\Configurations.

5. Esegui il file installandstartallservices e accedi alla o aggiorna la pagina web IQ Bot.
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Utilizzo del motore Google Vision API OCR
Utilizzare il motore Google Vision API OCR con IQ Bot per migliorare la precisione dei risultati del
riconoscimento ottico dei caratteri (OCR) per i documenti di formazione nelle lingue asiatiche, in particolare
in giapponese e coreano.  Il motore Google Vision API OCR in IQ Bot supporta tutte le lingue supportate
dal motore.
Verifica che la porta predefinita 443 sia disponibile per abilitare la comunicazione per l'endpoint API con
TCP.

Nota:  Consulta un elenco di URL di servizio consentiti per l'utilizzo di Google Vision API nella sezione degli
esempi riportata di seguito.

I file Google Vision API vengono installati automaticamente nella macchina durante l'installazione di IQ Bot
e vengono forniti come plug-in integrato, con un'installazione in un unico passaggio, diventando disponibili
per tutti gli utenti:
• È un motore OCR nel cloud.
• Google Vision API non supporta documenti con più lingue. Prima di utilizzare questa funzione, assicurati

di voler estrarre principalmente solo testo giapponese o coreano.
• Le lingue scritte da destra a sinistra, invece che da sinistra a destra, non sono supportate da IQ Bot

per l'estrazione dei documenti. Ad esempio arabo, aramaico, azero, divehi, fula, ebraico, curdo, n'ko,
persiano, rohingya, siriaco e urdu.
Prima di questa versione, il motore supportava principalmente l'estrazione dei dati solo per il testo
giapponese e coreano.
Languages supported in Automation 360 IQ Bot alla pagina 2481

• I dati non vengono archiviati in Google Cloud e vengono rimossi immediatamente.
Per ulteriori informazioni sulla privacy per la conservazione dei dati, vedi: Google Data Usage

IQ Bot fornisce la licenza per utilizzare il motore Google Vision API OCR. Puoi anche utilizzare il tuo codice
di licenza.
Utilizzo dei codici di licenza personali per il motore Google Vision API OCR alla pagina 1105

Nota:  Updates to Google Vision API such as OCR engine improvements, enhancements, and bug fixes
might affect content extraction when you use this OCR engine in IQ Bot. Therefore, we recommend that
you periodically refer to the Google Vision API release notes for the latest updates.
Consulta Potential impact of Google Vision API OCR upgrade alla pagina 1106.

Per l'utilizzo di questo motore OCR sono disponibili le seguenti opzioni:

Opzioni Descrizione

Opzione 1: imposta Google Vision API come
motore predefinito

Configura il file Settings.txt.

Limitazione:  La configurazione del file
settings.txt non è applicabile a Automation
360 IQ Bot Cloud

Opzione 2: seleziona il motore Google Vision
API direttamente dall'interfaccia utente durante
la creazione di un'istanza di apprendimento

Selezione di un motore OCR alla pagina 2490
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Per impostare Google Vision API come motore OCR predefinito, configura il file Settings.txt come
segue:

Limitazione:  La configurazione del file settings.txt non è applicabile a Automation 360 IQ Bot Cloud

1. Esegui il programma di installazione di IQ Bot.
2. Opzionale: Imposta Google Vision API come OCR predefinito per le nuove istanze di apprendimento.

Accedi a ..\Automation 360 IQ Bot\Configurations\Settings.txt e modifica il seguente
valore: OCREngine=GoogleVisionAPI.
Questo imposterà il motore Google Vision API OCR come motore predefinito per il tuo ambiente.

3. Il file GoogleOCREngineSettings.json viene generato all'interno della cartella ..\Automation
 360 IQ Bot\Configurations con valori predefiniti nel modo seguente:
Utilizza quanto segue con Google Vision API:

{
  "ADCJson": null,
  "EngineType": 2,
  "EnableFieldMerging": true,
  "EnableFieldRegions": true,
  "DebuggingFolder": "C:\\Users\\Public\\Documents\\Automation 360 IQBot
 Platform\\Logs\\Engine\\Google"
 }

4. Per i documenti in lingua giapponese e coreana, aggiorna il campo: "EnableCustomParse": true.

Nota:  Non è necessario riavviare il servizio dopo aver apportato la modifica.

Elenco degli URL di servizio utilizzati per Google Vision API (facoltativo)
Se necessario, utilizza i seguenti URL consentiti:

Nota:  Tutti gli URL puntano a una regione del servizio globale negli Stati Uniti.

• URL API: https://vision.googleapis.com/
• URL di autenticazione: https://accounts.google.com/o/oauth2/auth
• URL token: https://oauth2.googleapis.com/token
• URL provider di autenticazione: https://www.googleapis.com/oauth2/v1/certs
• URL autorizzazione client: https://www.googleapis.com/robot/v1/metadata/x509

1. Crea una nuova istanza di apprendimento con il documento in lingua asiatica che desideri formare.
2. Forma il documento e imposta l'istanza di apprendimento su produzione.
3. Carica i file della lingua asiatica ed esegui bot.
4. Scarica per visualizzare l'accuratezza dei risultati di estrazione.

Utilizzo dei codici di licenza personali per il motore Google Vision API OCR
Puoi utilizzare i tuoi codici per sottoscrivere il motore OCR Google Vision API.
Gli utenti possono utilizzare la propria autenticazione di Google Vision API. Devono creare Google Cloud
Application Default Credentials (ADC) e copiare il contenuto dal file ADC JSON nel campo "ADCJson" in
GoogleVisionOCREngineSettings.json..
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Nota:  Utilizza il collegamento per creare Google Cloud Application Default Credentials per Google Vision
API: https://cloud.google.com/docs/authentication/production.

Completa la procedura riportata di seguito per utilizzare le tue chiavi per il motore OCR Google Vision API.
1. Per impostazione predefinita, vengono utilizzate le chiavi di sottoscrizione crittografate Google Vision

API di IQ Bot. If you prefer to use your own Google Vision API subscription keys, go to C:\Program
 Files (x86)\Automation Anywhere IQ Bot <version>\Configurations, and folder
Configurations > GoogleVisionOCREngineSettings.json file, and specify your keys.

2. IQ Bot fornisce una licenza integrata per Google Vision API, tuttavia puoi sovrascrivere questa licenza
se desideri utilizzarne una tua. Copia correttamente il contenuto dal file ADC JSON per assicurare che
vengano utilizzate le chiamate API corrette modo seguente:

{
  "ADCJson": {
    "type": "service_account",
    "project_id": "dark-caldron",
    "private_key_id": "9e83979f61cff072d0e0e4f91bf837e6e29bbb",
    "private_key": "-----BEGIN PRIVATE KEY-----\nMIIEvgIBADANBg......----
END PRIVATE KEY-----\n",
    "client_email": "vision-test@dark-caldron.iam.gserviceaccount.com",
    "client_id": "105342202023265468399",
    "auth_uri": "https://accounts.google.com/o/oauth2/auth",
    "token_uri": "https://oauth2.googleapis.com/token",
    "auth_provider_x509_cert_url": "https://www.googleapis.com/oauth2/v1/
certs",
    "client_x509_cert_url": "https://www.googleapis.com/robot/v1/
metadata/x509/vision-test%40dark-caldron-254807.iam.gserviceaccount.com"
  },
  "EngineType": 2,
  "EnableDebugging": false,
  "DebuggingFolder": "C:\\Users\\Public\\Documents\\Automation Anywhere
 IQBot Platform\\Logs\\Engine\\Google",
  "HttpTimeoutInSec": 300,
  "EnableCustomParse": false,
  "DistanceThreshold": 15
}

Potential impact of Google Vision API OCR upgrade
Google Vision API OCR is Cloud based, and typically, it is upgraded to a newer version according to
Google's release cycle. As a result of this upgrade, an impact might be observed on document extraction
processing and extraction results in IQ Bot.

Impact on document classification in IQ Bot after the update of Google Vision
API OCR

The classification of documents is based on the OCR result, particularly the order in which the fields
are detected. Thus, if the content of the OCR results varies, then the classification results of the similar
document processed previously might show visible differences during document extraction.
The auto-upgrade affects the classifier service in two ways:
• Different groups are assigned to documents: The documents when processed will be assigned to

different groups versus what they were originally routed to so far. Consequently, some data extractions
might fail, which were previously successful.
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• New groups are created: The documents previously being processed with a group might now result
in new group being created.

Impact on data extraction in IQ Bot after update of Google Vision API OCR

A change in OCR output might result in the following differences during data extraction from a similar
document type:
• Improvement in character recognition and its associated impact: As a result of improved

keyword character recognition, previously unrecognized values from a document will now provide better
extraction results.

Nota:  If any processing logic is written to fix the lack of detected characters, it might cause issues
when the document is processed.

• Degradation in character recognition and its impact: Validation might fail due to degradation in
OCR output, and the document will be routed to the Validator. In a scenario where there is no validation
setup, the extracted data output might see a degradation.

Options to mitigate

If you encounter any of the previously mentioned issues, you have the following options to explore:
• Retrain existing learning instance to fix issues with document classification.
• Write processing logic using Python to mitigate extraction outcomes.
• Evaluate creating learning instance with different OCR provider supported by IQ Bot.
• Raise a support ticket with Automation Anywhere.

Utilizzo del motore Tegaki API OCR
Utilizza il motore Tegaki API OCR con IQ Bot per migliorare la precisione dei risultati del riconoscimento
ottico dei caratteri (OCR) utilizzati per i documenti di formazione in giapponese e coreano. Puoi
configurarlo per l'uso con Automation 360 IQ Bot On-Premises.
Esamina i seguenti prerequisiti per la configurazione del motore Tegaki API OCR:
• Solo Automation 360 IQ BotOn-Premises supporta Tegaki APIOCR.
• Devi avere un server dedicato che soddisfi i requisiti stabiliti da Cogent Labs. Per ulteriori informazioni,

contatta il tuo Customer Success Manager.
• IQ Bot fornisce Tegaki API come plug-in integrato. Imposta Tegaki API come motore OCR predefinito

nel file settings.txt disponibile nella seguente cartella:
C:\Program Files (x86)\Automation 360 IQ Bot <version>\Configurations

• Set the communication for the API endpoint on default port = 443, using TCP protocol.

Importante:  Non disponibile in Automation 360 IQ Bot Cloud.

Tegaki API OCR supporta documenti nelle seguenti lingue:
• Giapponese
• Coreano
• Giapponese - Inglese
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• Coreano - Inglese

1. Esegui il programma di installazione di IQ Bot.
2. Configura il motore Tegaki API OCR per la versione On-Premises sul tuo computer in base alle

istruzioni ricevute dal rappresentante Automation Anywhere.
3. Immetti il codice di licenza nel file OCR Tegaki settings.json.

Poiché IQ Bot non fornisce la licenza per l'utilizzo del motore Tegaki API OCR, devi utilizzare la tua
chiave di licenza. Segui i passaggi per installare il codice di licenza specifico:
a. Accedi alla seguente posizione:

C:\Program Files (x86)\Automation 360 IQ Bot\Configurations

b. Configura l'endpoint Tegaki API in cui è stata installata la versione On-Premises. Set APIKey =
 <your key here> and configure the TegakiOCREngineSettings.json file.

{
  "APIKey": "<ensure your key meets UUID format (https://
www.uuidgenerator.net)>”,
  "RestEndpointURL": "<your Tegaki Server URL here>”,
  "RestEndpointPort": <80>,
  "EngineType": 3,
  "EnableFieldMerging": false,
  "EnableFieldRegions": false,
  "DebuggingFolder": "C:\\Users\\Public\\Documents\\Automation
 Anywhere IQBot Platform\\Logs\\Engine\\Tegaki"
}

Consulta How to change OCR Settings in IQ Bot (A-People login required).

4. Accedi a ..\Automation 360 IQ Bot\Configurations\Settings.txt e modifica il seguente
valore: OCREngine=TegakiAPI.
Il file TegakiOCREngineSettings.json è disponibile dopo l'installazione di IQ Bot.

1. Crea una nuova istanza di apprendimento con il documento in lingua asiatica che desideri formare.
2. Forma il documento e imposta l'istanza di apprendimento su produzione.
3. Carica i file della lingua asiatica ed esegui bot.
4. Scarica per visualizzare l'accuratezza dei risultati di estrazione.

Concetti correlati
Installazione e aggiornamento Automation 360 IQ Bot alla pagina 1066
This collection of topics guide you through the process of installing or setting up Automation 360 IQ Bot
On-Premises and Cloud.

Risoluzione dell'errore di registrazione di IQ Bot
Se la registrazione di IQ Bot non riesce a causa di problemi con l'URL HTTPS, segui le istruzioni riportate in
questo argomento.
1. Utilizza Servizi di Windows per riavviare il servizio Control Room.
2. Aggiorna l'URL HTTPS di Control Room accedendo a Control Room > Amministrazione >

Impostazioni > Generali.
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3. Utilizza Servizi di Windows per riavviare i seguenti servizi:
• Automation Anywhere Control Room Cognitive Console
• Automation Anywhere Control Room Reverse Proxy

4. Registra nuovamente IQ Bot con l'URL HTTPS in Control Room.
IQ Bot viene registrato correttamente.

Annullamento della registrazione di IQ Bot da Control Room
È necessario annullare la registrazione di IQ Bot da Control Room se l'URL di IQ Botcambia a causa
dell'installazione o della disinstallazione di IQ Bot oppure se viene aggiunto un sistema di bilanciamento del
carico.
Dopo aver annullato la registrazione di IQ Bot da Automation Anywhere Control Room, riavvia il servizio
Automation Anywhere Cognitive Console.
1. Utilizzando il ruolo sysadmin, esegui due query SQL separate in database diversi.
2. Esegui il primo set di istruzioni SQL nel database Control Room per eliminare i seguenti dati:

Esegui le seguenti istruzioni SQL per le versioni da A2019.10 a A2019.13:

DELETE FROM [AAE-Database].[dbo].[ACTIVEMQ_ACKS]

DELETE FROM [AAE-Database].[dbo].[ACTIVEMQ_MSGS]

DELETE FROM [AAE-Database].[dbo].[SERVICE_USER]

DELETE FROM [AAE-Database].[dbo].[USERS] where user_type='APP'

Run the following SQL statements for version A2019.14 and later:
a. Esegui la query seguente:

USE [AAE-Database]
SELECT T.uuid As TenantID,T.name AS
 TenantName,T.created_by,T.enabled,U.id AS
 IQBotAppUserId,U.user_type,S.url AS 
IQBotURL FROM [dbo].[TENANTS] T 
LEFT JOIN [dbo].[USERS] U ON T.uuid = U.tenant_uuid 
LEFT JOIN [dbo].[SERVICE_USER] S ON U.id = S.id
WHERE (U.user_type='APP' AND S.type='IQBOT')

b. La query di cui sopra restituirà un numero "IQBotAppUserId". Replace id = 'IQBotAppUserId'.
c. Esegui le query di eliminazione seguenti:

DELETE FROM [AAE-Database].[dbo].[SERVICE_USER] WHERE [type]='IQBOT'

d. DELETE FROM [AAE-Database].[dbo].[USERS] WHERE id = 'IQBotAppUserId'
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3. Esegui il secondo set di istruzioni SQL nel database di configurazione di IQ Bot per eliminare i seguenti
dati:
• DELETE FROM [IQBot].[dbo].[Configurations] where

 [key]='controlRoomVersion'

• DELETE FROM [IQBot].[dbo].[Configurations] where [key]='appRegistered'

• DELETE FROM [IQBot].[dbo].[Configurations] where [key]='controlRoomUrl'

• DELETE FROM [IQBot].[dbo].[Configurations] where [key]='appId'

La registrazione è stata annullata correttamente.

Impostazione del rollover automatico dei file di log
Questo argomento descrive la configurazione del rollover automatico dei file di log in base alle dimensioni
del file.
After the log files are created, the system continues logging messages, which increases the log file size to
a point where they are too large to open. This prevents the user from opening the log files for reviewing
the information and error messages.

Nota:
• This happens sooner if the logging level is increased to DEBUG or TRACE modes.
• To ensure smooth operation of the system, manual clear the logs periodically.

Per tutti i servizi Java, l'utente può identificare i file di registro in <IQ Bot installation
 directory>/Services . Apri un qualsiasi file di configurazione di registrazione e aggiungi la seguente
modifica in <SizeBasedTriggeringPolicy size="100MB" /> nella prima occorrenza di Criteri:

<Policies>
<TimeBasedTriggeringPolicy interval="720" />
<SizeBasedTriggeringPolicy size="50MB" />
</Policies>

In the following example setting, after the log file reaches 50 MB, the system creates a new file
automatically and starts logging in it. Though the user ends up with more files, but each file would be 50
MB only. This is standard practice to manage log files.

Questo esempio mostra le voci che un utente può aggiungere all'impostazione per Automation 360 IQ
Bot On-Premises affinché esegua automaticamente il rollover dei log quando i file raggiungono una
determinata dimensione.

<RollingFile name="Alias" fileName="${env:PUBLIC}/Documents/Automation
 Anywhere IQBot Platform/Logs/Alias.log"
                     filePattern="${env:PUBLIC}/Documents/Automation
 Anywhere IQBot Platform/Logs/Archive/$${date:yyyy-MMM}/Alias-%d{yyyy-MMM-
dd}-%i.log.zip"
                     immediateFlush="true"
                     append="true">
            <PatternLayout pattern="CPL1 Alias %X{cid} %d{ISO8601}{UTC}Z
 %-5level %C %M %msg %n"/>
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            <Policies>
                <TimeBasedTriggeringPolicy />
                <SizeBasedTriggeringPolicy size="50MB" />
            </Policies>
            <DefaultRolloverStrategy max="10"/>
        </RollingFile>

Risposta dell'API di controllo dell’integrità se l’avvio di RabbitMQ v3.8.18 non
riesce
Puoi controllare lo stato di ciascun servizio IQ Bot utilizzando l'API di controllo dell’integrità quando l’avvio
di RabbitMQ v3.8.18 non riesce.
La risposta del controllo di integrità a seguito dell'avvio non riuscito di RabbitMQ è diversa in caso di
FileManager, Project, Validator e VisionBot come mostrato nella seguente tabella.

Nome del servizio Risposta del controllo di
integrità

Motivo dell'errore

FileManager

http://
<hostname>:<9996>/
healthcheck

Errore 1:
localhost refused to
 connect

Errore 2:
localhost refused to
 connect

Motivo dell'errore 1:
Il nodo/servizio RabbitMQ
v3.8.18 si è arrestato mentre
il servizio Filemanager era in
esecuzione.
Motivo dell'errore 2:
Il nodo/servizio RabbitMQ era
già inattivo quando il servizio
Filemanager è stato avviato.

Project

http://
<hostname>:<9999>/
healthcheck

Errore:
localhost refused to
 connect

Motivo dell'errore:
IL nodo/servizio RabbitMQ
v3.8.18 è inattivo.

Validator

http://
<hostname>:<9995>/
healthcheck

Errore:
localhost refused to
 connect

Motivo dell'errore:
IL nodo/servizio RabbitMQ
v3.8.18 è inattivo.

VisionBotManager

http://
<hostname>:<9998>/
healthcheck

Errore:
localhost refused to
 connect

Motivo dell'errore:
IL nodo/servizio RabbitMQ
v3.8.18 è inattivo.
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Nome del servizio Risposta del controllo di
integrità

Motivo dell'errore

Gateway-2 service

http://<hostname>:8100/
healthcheck

Applicazione: gateway-2
Errore 1:
localhost refused to
 connect

Errore 2:
localhost refused to
 connect

Motivo dell'errore 1:
La porta è bloccata e il servizio
Gateway-2 è in esecuzione.
Motivo dell'errore 2:
Il servizio Gateway-2 non è in
esecuzione.

Reinstallazione di un certificato HTTPS SSL scaduto per garantire una
comunicazione sicura
Reinstall HTTPs SSL certificate in Automation 360 IQ Bot when your HTTPS SSL certificate expires.
Il certificato HTTPS SSL è richiesto per una comunicazione sicura e crittografata tra il browser e IQ Bot
al fine di proteggere transazioni online altamente riservate come le transazioni finanziarie e gli acquisti.
L'icona del lucchetto sul browser indica che disponi di una connessione sicura attiva.
Per abilitare una connessione sicura devi ottenere il certificato HTTPS SSL, nel modo seguente:
1. Accedi a %installation_dir%\Configurations e, come amministratore, esegui

stopanduninstallallservices.bat.

Nota:  In un'installazione cluster devi arrestare i servizi su ciascuno dei nodi per IQ Bot e il cluster
Control Room.

2. Accedi a %installation_dir%\Portal\keys e fai un backup dei file cert.crt, key.key e
ca.crt.

3. Converti il file .pfx del certificato IQ Bot nei formati .crt e .key eseguendo i seguenti comandi:
• Estrai una chiave crittografata dal file .pfx.

openssl.exe pkcs12 -in "path_to_cert\example.pfx" -nocerts -out
"path_to_cert\example encp.key" 

Nota:  Se il file .pfx è protetto da password, è necessario immettere la passphrase quando
richiesto.

• Converti la chiave crittografata in un formato leggibile.

openssl.exe rsa -in "path_to_cert\example encp.key" -out "path_to_cert
\key.key"
This command converts encrypted key to a readable format.

• Converti il file .pfx in formato .crt.

openssl.exe pkcs12 -in "path_to_cert\example.pfx" -clcerts -nokeys -out
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"path_to_cert\cert.crt"

• Recupera il file ca.crt dal file di certificazione (.pfx) di Control Room solo se anche il certificato di
Control Room scade.

openssl pkcs12 -in <filename.pfx> -cacerts -nokeys -chain -out <ca.crt>

4. Copia o sostituisci i file cert.crt e key.key (generati nella fase precedente), e ca.cert (generato
utilizzando il file .pfx del certificato di Control Room) nella cartella %installation_dir%\Portal
\keys.

5. Importa il certificato IQ Bot pubblico nell'archivio delle chiavi Java per IQ Bot eseguendo questo
comando come amministratore di sistema:

 
"JRE Location\bin\keytool.exe" -import -alias iqbot-keystore "cacerts
 location of iq bot" -file " iq bot public certificate file"

Esempio: C:\Program Files (x86)\Automation Anywhere IQ Bot <version number>
\JRE\1.8.0_161\bin\keytool.exe" -import -alias cr -keystore "C:\Program
 Files (x86)\Automation Anywhere IQ Bot <version number>\JRE\1.8.0_161\lib
\security\cacerts" -file "C:\Certificate\cert.crt

6. Per importare il certificato IQ Bot pubblico in Control Room, accedi al percorso di installazione di
Control Room, ad esempio: C:\Program Files\Automation Anywhere\Enterprise, ed esegui
il seguente comando come amministratore di sistema: jrk\bin\java -jar certmgr.jar -
appDir "C:\Program Files\Automation Anywhere\Enterprise" -importTrustCert
 "C:\Certificate\cert.crt".

7. Dopo aver importato i certificati, riavvia Control Room e i server IQ Bot.
Questa operazione aggiorna le cache del sistema.

8. Sul server IQ Bot, accedi a %installation_dir%\Configurations e, come amministratore,
esegui installandstartallservices.bat.

Se il certificato di Control Room scade
1. Follow the steps: Import HTTPS and CA certificates

2. Convert .pfx to .crt format.openssl.exe pkcs12 -in "path_to_cert\example.pfx" -
clcerts -nokeys -out "path_to_cert\cert.crt".

3. Fetch the ca.crt file from the Control Room certificate (.pfx) file.openssl pkcs12 -in
 <filename.pfx> -cacerts -nokeys -chain -out <ca.crt>

4. Copia o sostituisce ca.cert nella cartella delle chiavi in IQ Bot.
5. Importa il certificato pubblico di Control Room nell'archivio chiavi Java di IQ Bot eseguendo questo

comando come amministratore di sistema: "JRE Location\bin\keytool.exe" -import -
alias cr -keystore "cacerts location of iq bot" -file "control room public
 certificate file".
Esempio: C:\Program Files (x86)\Automation Anywhere IQ Bot <version number>
\JRE\1.8.0_161\bin\keytool.exe" -import -alias cr -keystore "C:\Program
 Files (x86)\Automation Anywhere IQ Bot <version number>\JRE\1.8.0_161\lib
\security\cacerts" -file "C:\Certificate\cert.crt

Nota:  To change the Control Room certificate, follow steps here: Import HTTPS and CA certificates
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Aggiornamento di Automation 360 IQ Bot
Puoi eseguire l'aggiornamento di Automation 360 IQ Bot On-Premises all’ultima versione per ottenere tutte
le funzionalità e i miglioramenti più recenti.
Assicurati di eseguire il backup delle istanze di apprendimento IQ Bot esistenti. A seconda della versione di
Automation 360 IQ Bot attualmente in uso, sono disponibili le seguenti opzioni di aggiornamento:
• Aggiornamento dalle build Automation 360 IQ Bot precedenti (1089, 1598 e 2079) alla

versione Automation 360 IQ Bot On-Prem più recente
Le versioni precedenti di Automation 360 IQ Bot avevano cinque database. A partire da Automation
360 IQ Bot On-Premises Build 2545, è disponibile un singolo database unificato. Utilizza lo script di
migrazione per eseguire la migrazione di questi cinque database in un database unificato.
Esegui script di migrazione del database IQ Bot On-Premises alla pagina 1114

• Aggiornamento alla versione più recente di Automation 360 IQ Bot On-Prem.
Assicurati di aggiornare la copia di Automation 360 IQ Bot On-Premises esistente alla versione più
recente la quale fornisce miglioramenti del prodotto e correzioni dei bug.
Aggiornamento di Automation 360 IQ Bot On-Premises alla versione più recente alla pagina 1115

• Troubleshoot CyberArk vault integration for upgrade
If you encounter a vault key validation error while upgrading Automation 360 IQ Bot to Build 15112,
troubleshoot the issue by ensuring the JDBC Driver is in the C:\Windows\System32 folder.
Troubleshoot CyberArk vault integration for upgrade (A-People login required)

Esegui script di migrazione del database IQ Bot On-Premises
Le build IQ Bot On-Premises 1089, 1598 e 2079 includevano cinque database. A partire da IQ Bot On-
Premises Build 2545, è supportato un unico database unificato. È necessario eseguire uno script di
migrazione per migrare i database delle build 1089, 1598, 2079 alla build più recente.
Prima di eseguire lo script di migrazione, è necessario disporre della build di IQ Bot On-Premises più
recente e verificare che l'utilità di comando SQL sqlcmd.exe sia installata sul sistema.
Verificare inoltre che Microsoft ODBC Driver 17 per SQL Server sia installato sul server IQ Bot. Questo può
essere ottenuto da: https://www.microsoft.com/en-us/download/details.aspx?id=56567

1. Disinstalla la build corrente di IQ Bot On-Premises.
2. Installa la build IQ Bot On-Premises più recente.

Durante l'installazione, viene creato un nuovo database IQ Bot.

Nota:  Ricorda il nome utente e la password del database per aggiornare il valore dello script di
migrazione.

3. Accedi alla cartella Binn.
Questa potrebbe trovarsi in C:\Program Files\Microsoft SQL Server\Client SDK\ODBC
\170\Tools\Binn.
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4. Verifica che SQLCMD.exe sia installato.
Se SQLCMD.exe non è installato, procedi come segue:
a. Scarica ed estrai Data Migration.zip dalla cartella Installazione e configurazione sul server IQ

Bot.
b. Accedi a DataMigration > UTILITY-MsSqlCmdLnUtils.
c. Esegui MsSqlCmdLnUtils.msi per installare SQLCMD.exe.

Dopo aver installato SQLCMD.exe, esegui lo script di migrazione.
1. Accedi al file AA.IQBot_Database_Migration.bat nella cartella DataMigration.
2. Modifica il file AA.IQBot_Database_Migration.bat.
3. Aggiorna i valori come segue:

a) Set the SQLCMD value to the path of your Binn.

SQLCMD="C:\Program Files\Microsoft SQL Server\Client SDK\ODBC\170\Tools
\Binn\SQLCMD.exe"

b) Set LOGIN value to your database username.
LOGIN="database username"

Nota:  Per eseguire lo script di migrazione sono necessari i ruoli bulkadmin, dbcreator e
public.

c) Set the PASSWORD value to your database password.
PASSWORD="database password"

d) Set the SERVER value to the path of your database server hostname.
SERVER="path of database server hostname"

4. Esegui il file dello script di migrazione AA_IQBot_Database_Migration.bat con i privilegi di
amministratore.
Al termine della migrazione, viene creato un output. Verifica C:\Datamigrationlog.txt per la
cronologia del registro e gli errori.

Nota:  Se un output non viene visualizzato, contatta l'assistenza.

Aggiornamento di Automation 360 IQ Bot On-Premises alla versione più
recente
Se stai utilizzando una delle versioni di Automation 360 IQ Bot On-Premises precedenti, puoi eseguire
l’aggiornamento alla versione più recente, la quale offre miglioramenti e correzioni di bug.
Ti consigliamo di esaminare la versione di Automation 360 IQ Bot On-Premises esistente e di eseguire il
backup del database, del percorso di output e dei file di configurazione dell'installazione.
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Nota:  Disinstalla la versione di Automation 360 IQ Bot On-Premises esistente dal dispositivo prima di
eseguire l'aggiornamento alla versione più recente.

1. Accedi al sito di supporto di Automation Anywhere per scaricare la versione del file di installazione di
Automation 360 IQ Bot più recente.
A-People Downloads page (Login required)

2. Fai clic sul collegamento al file di installazione di Automation 360 IQ Bot più recente.
3. Fai clic su Installazione e configurazione.
4. Scarica e installa il file Automation_Anywhere_IQ_Bot_A2019_Build_<build number>.exe.

Installazione e aggiornamento Automation 360 IQ Bot alla pagina 1066

Nel dispositivo deve essere installata la versione di Automation 360 IQ Bot On-Premises più recente.

Aggiornamento e downgrade di IQ Bot
Puoi disinstallare e installare una versione più recente per effettuare l'aggiornamento di IQ Bot. Puoi
disinstallare e installare una versione di IQ Bot precedente per effettuare il downgrade.
Per eseguire l'aggiornamento o il downgrade di IQ Bot, effettua la seguente procedura.
• Aggiornamento di IQ Bot

a) Crea una nuova cartella in qualsiasi posizione ed esegui un backup di
Settings.txt di entrambi o uno dei file .json ImageProcessingConfig.json o
AbbyyImagePreProcessingSettings.json per riferimento dalla cartella <Installation Path/
Configuration> nella nuova cartella.

b) Esegui il backup dei database di IQ Bot esistenti prima di avviare l'aggiornamento.
c) Follow the uninstall process:

Disinstallazione di IQ Bot alla pagina 1117
d) Copia una versione successiva del file installabile di IQ Bot da <path of the installable file> al tuo

sistema locale.
e) Segui il processo di installazione.

Nota:
• Per immettere i valori di configurazione quando si installa una versione precedente

del prodotto, fare riferimento alle impostazioni contenute nel file Settings.txt
e in entrambi o in uno dei file .json ImageProcessingConfig.json o
AbbyyImagePreProcessingSettings.json.

• Esegui il backup del database per ripristinarlo in caso di eventuali problemi in futuro oppure nel
caso in cui esegui il downgrade a una versione di IQ Bot precedente.

• If you are using the ABBYY FineReader Engine OCR, you must update the folder path to the
AbbyyOCREngineSettings.json configuration file after completing the upgrade installation
steps.

Migrazione delle istanze di apprendimento alla pagina 1347

• Downgrade di IQ Bot
a) Crea una nuova cartella in qualsiasi posizione ed esegui un backup di

Settings.txt di entrambi o uno dei file .json ImageProcessingConfig.json o
AbbyyImagePreProcessingSettings.json per riferimento dalla cartella <Installation Path/
Configuration> nella nuova cartella.

© 2023 Automation Anywhere. All rights reserved.     1116

https://apeople.automationanywhere.com/s/downloads


    Automation Anywhere - Installazione e aggiornamento Automation 360

b) Disinstalla la versione di IQ Bot più recente.
c) Esegui il backup dei database attuali,
d) Rimuove il backup dei database attuali,
e) Ripristina il backup del database della versione di IQ Bot precedente.
f) Installa la versione di IQ Bot precedente.

Nota:
• Per immettere i valori di configurazione quando si installa una versione precedente

del prodotto, fare riferimento alle impostazioni contenute nel file Settings.txt
e in entrambi o in uno dei file .json ImageProcessingConfig.json o
AbbyyImagePreProcessingSettings.json.

• Esegui il backup del database per ripristinarlo in caso di eventuali problemi in futuro o nel caso
in cui esegua l'aggiornamento a una versione diversa di IQ Bot.

Disinstallazione di IQ Bot
Se è stato installato Automation 360 IQ Bot On-Premises, procedi come segue per disinstallare IQ Bot e le
relative dipendenze.
To manually uninstall, go to Windows > Control Panel > Programs > Uninstall a program, and
choose IQ Bot.
Per tutte le altre versioni, completa la procedura seguente.
1. Fai doppio clic sul file di installazione Automation_360_IQ_BOT_<version-number>.exe. Viene

visualizzata la procedura guidata Automation Anywhere IQ Bot.
2. Immetti le autorizzazioni amministrative nella finestra di dialogo Controllo di accesso utente se

viene visualizzata una finestra di dialogo.

Nota:  Assicurati di chiudere tutte le istanze del browser esistenti in esecuzione in IQ Bot prima di
iniziare la disinstallazione.

3. Fai clic su Avanti. Viene visualizzata la pagina Pronto per la rimozione.
4. Fai clic su Rimuovi.

Ha inizio il processo di disinstallazione.

Nota:  During the uninstallation process, if setup information appears, click OK to continue. Fai clic su
Annulla per terminare il processo.

5. Al termine, viene visualizzata la pagina Fine. Click Finish to complete the process.

Nota:  La disinstallazione di IQ Bot non elimina il database IQ Bot o una delle seguenti dipendenze. Devi
rimuoverli manualmente utilizzando le procedure consigliate di terzi.
• Erlang/OTP
• RabbitMQ v3.8.18
• NodeJS
• SQL Server Native Client
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• Python

Panoramica della disponibilità elevata e del ripristino di emergenza
La disponibilità elevata (High Availability, HA) fornisce una meccanismo di failover in caso di errori del
servizio, del server o del server di IQ Bot. Il ripristino di emergenza (Disaster Recovery, DR) consente il
ripristino in punti dislocati in aree geografiche differenti nel caso di un'emergenza che causa errori in un
intero data center.
IQ Bot utilizza un minimo di 3 nodi e un massimo di 5 nodi in un cluster per la disponibilità elevata (HA).

Soluzione HA e DR di IQ Bot

Nel contesto di IQ Bot, l'implementazione di disponibilità elevata (HA) e ripristino di emergenza (DR) riduce
il tempo di inattività e mantiene la continuità operativa (Continuity of Business, CoB) per le attività dei bot.
• Disponibilità elevata (HA): la disponibilità elevata è una progettazione architettonica che tenta di

salvaguardare un sistema da determinati scenari di guasti. Ciò significa che anche se parti di un sistema
si guastano, il sistema nel suo insieme è ancora disponibile e utilizzabile. Le soluzioni a disponibilità
elevata proteggono in genere da scenari specifici quali: guasti del server, guasti di singoli componenti,
guasti a livello di dipendenza, aumenti di carico variabili e reti suddivise, dove componenti dipendenti
dal sistema diventano irraggiungibili in una rete.

• Ripristino di emergenza (DR): comprende una serie di criteri e procedure per consentire il ripristino
o la continuazione dell'infrastruttura e dei sistemi essenziali in seguito a un disastro naturale o indotto
dall'uomo. Il ripristino di emergenza gestisce molte cause diverse di guasti in un sistema in cui la
disponibilità elevata rappresenta in genere un numero esiguo e prevedibile. Il ripristino di emergenza
si concentra sulla riattivazione dei servizi dopo un incidente e non solo di failover. Il ripristino di un
sistema include scenari quali: riavvio di un servizio o di un sistema, ripristino di file di configurazione o
database dai backup.

Per garantire la protezione HA e DR dei componenti di IQ Bot, configura l'infrastruttura HA e DR esistente,
il bilanciamento del carico e i sistemi di failover in modo da includere server e servizi di IQ Bot. Per le
procedure HA e DR locali approvate, consulta l'amministratore del data center.

Elementi dell'infrastruttura HA e DR richiesti

• Approccio distribuito: oltre al clustering dei componenti del data center relativi a IQ Bot, consigliamo
anche di distribuire IQ Bot su più server separati fisici e/o virtuali.

• Bilanciamento del carico: eseguito da un sistema di bilanciamento del carico, questo è il processo
di distribuzione del traffico di applicazioni o di rete su più server per proteggere le attività di servizio e
consente la distribuzione dei carichi di lavoro tra più server. Ciò garantisce che l'attività dei bot continui
su server di cluster.
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• Database: i database utilizzano il proprio failover integrato per proteggere i dati. Ciò garantisce il
recupero dei dati del database.
• Tra i cluster HA, configura la replica sincrona tra i server MS SQL in cluster primari (attivi) e

secondari (passivi) nel data center. Ciò garantisce la coerenza in caso di un errore del nodo del
database.
Per la replica sincrona HA richiesta, configura una delle opzioni seguenti:
• Replica di backup in modalità con commit sincrono dei gruppi di disponibilità di SQL

Server Always On
• Mirroring del database da SQL al server

• Tra i siti DR, configura il database per fornire una replica asincrona dal sito DR primario
(produzione) al sito DR secondario (ripristino) che si trova in una posizione geograficamente
separata dal sito DR primario.

Scenario di esempio

Punta tutte le istanze di IQ Bot presenti nello stesso cluster agli stessi file di database e archivio. Ciò è
necessario per consentire la condivisione dei dati su più server e garantire l'integrità dei dati tra i server di
IQ Bot in un cluster.

Modelli di distribuzione HA e DR

Per garantire che IQ Bot sia protetto dall'HA e/o del ripristino di emergenza configura i data center in base
ai modelli di implementazione descritti in:
• Modello di distribuzione a disponibilità elevata alla pagina 1122
• Modello di distribuzione con ripristino di emergenza alla pagina 1122

Requisiti di implementazione HA

• Installa IQ Bot su più server.
• Accedi a IQ Bot attraverso un bilanciamento del carico.
• Apri una porta di sincronizzazione di RabbitMQ v3.8.18 tra i server di IQ Bot.
• Configura Microsoft SQL Server in modalità disponibilità elevata.

Requisiti di configurazione di un'installazione HA e DR

• Lo strumento di installazione di IQ Bot non supporta direttamente l'installazione cluster. Per impostare
un cluster, effettua le seguenti operazioni:
• Esegui lo strumento di installazione su ciascun nodo del server applicazioni.
• Share the output folder using the access role Everyone.
• Post installation, execute the messagequeue_cluster_configuration.bat with appropriate

command line arguments.

• Configura IQ Bot in una configurazione a disponibilità elevata.
• Apri le porte firewall: 4369 e 25672.
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• Installa RabbitMQ v3.8.18 su ogni nodo di IQ Bot nel cluster.
Il primo nodo su cui IQ Bot è stato installato diventa il nodo di RabbitMQ v3.8.18 primario. Il nome host
del nodo primario viene utilizzato per configurare il cluster di RabbitMQ v3.8.18.

• Il bilanciamento del carico è necessario per distribuire il traffico a tutti i nodi del server di IQ Bot.
• Configura Microsoft SQL Server per la disponibilità elevata. Utilizza l'opzione Microsoft SQL Server

Always On.
• Per un'installazione specifica di RabbitMQ v3.8.18, vedi la documentazione di RabbitMQ v3.8.18.

Limitazioni note di HA e DR

• Per scoprire la disponibilità di istanze di IQ Bot, un bilanciamento del carico invia periodicamente ping,
tenta connessioni o invia richieste per testare le istanze di IQ Bot. Questi test sono chiamati controlli di
integrità.

• I controlli di integrità non verificano la disponibilità delle istanze di RabbitMQ v3.8.18.

Panoramica della configurazione del cluster HA
Per supportare il data center di Automation Anywhere, configura un cluster a disponibilità elevata (High
Availability, HA). Segui i metodi e le procedure aziendali per implementare il cluster del tuo data center.
I cluster HA proteggono i servizi e i dati in caso di errore di un server o un servizio. Di seguito è riportato
un elenco dei processi associati ai cluster.

Replica del database Configura la replica sincrona tra i server di Microsoft
SQL Server del sito primario (attivo) e del sito
secondario (passivo) per garantire la coerenza in
caso di errore di un nodo del database.

Tempo di inattività La durata del tempo di inattività dipende dal
numero di tentativi di riavvio che l'amministratore
configura per i servizi del server primario, dal
numero di failover consentiti per numero di ore e
dalla configurazione di failback.

Failback Dopo che il server primario è tornato alla normalità,
esegui il failback del carico di lavoro dai server
secondari ai server primari. Il server primario
diventa di nuovo il server attivo.
Ripristino delle operazioni sul sistema o sul
sito primario dopo un failover o un ripristino di
emergenza su un sistema o un sito secondario.

Failover Se si verifica un errore in uno dei server principali,
il carico di lavoro del server guasto passa
automaticamente al server secondario nel cluster.
Questo processo di automazione è chiamato
failover. Il failover garantisce la disponibilità
continua di applicazioni e dati. Al termine del
failover, il server secondario diventa il server attivo.
Quando un sistema (primario) rileva un errore o un
guasto, trasferisce automaticamente il controllo a
un sistema duplicato (secondario). Questo si applica
ai cluster HA, dove il failover avviene da un server
all'altro.
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Riduzione controllata delle prestazioni Processo che consente alle dipendenze del cluster
di operare normalmente su un sito primario
danneggiato.

Ridondanza I cluster HA utilizzano la ridondanza per prevenire
singoli punti di errore (Single Point Of Failure,
SPOF), come un server o un servizio con errori.
I cluster HA includono server primari (attivi), che
ospitano servizi o database e server secondari
(passivi), che ospitano copie replicate dei servizi e
dei database.

Replica I server secondari hanno la stessa configurazione
e lo stesso software dei server principali e sono un
duplicato (copia ridondante) di suddetti server. I
dati vengono replicati (copiati) dai server principali
ai server secondari.

Per supportare HA e DR per Automation Anywhere, configura i componenti selezionati nel data center per
HA.

Nota:  sebbene i termini server, host e nodo abbiano un significato specifico, nel contesto dei cluster
vengono utilizzati frequentemente in modo intercambiabile.

Cluster Un cluster è un set di server (nodi) connessi tramite
cavi fisici e software. In un ambiente HA, i cluster
di server possono essere nello stesso data center
fisico.

Gruppo cluster (ruolo) Gruppo di servizi raggruppati dei quali viene
eseguito il failover insieme e che dipendono l'uno
dall'altro.

Host La macchina cluster che ospita i servizi.
Più server La tecnica HA in cui le operazioni sono disponibili

su più server con carico di lavoro gestito da un
bilanciamento del carico. Questo si applica alle
istanze di IQ Bot.

Nodo Termine generico per una macchina in un cluster.
Nodo primario Il nodo attivo nel cluster. La macchina in cui si

svolgono le attività di produzione. Questo si applica
ai server di database.

Nodo secondario La macchina designata come destinazione in caso di
failover. Il nodo secondario è un duplicato passivo
del nodo primario. Questo si applica ai server di
database.

Server La macchina nel cluster installato con il sistema
operativo del server.

Le tecnologie cluster HA proteggono da tre tipi specifici di errori:

Errori di applicazioni e servizi Questi influiscono sul software applicativo e sui
servizi essenziali.

Guasti del sito in organizzazioni multisito Sono causati da disastri naturali, interruzioni di
corrente o interruzioni di connettività.
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Guasti di sistema e hardware Interessano componenti hardware quali CPU, unità
disco, memoria, schede di rete e alimentatori.

La capacità di gestire il guasto consente ai cluster di soddisfare due requisiti tipici nella maggior parte degli
ambienti data center:

Disponibilità elevata La capacità di fornire agli utenti finali l'accesso a
un servizio per un'elevata percentuale di tempo e
ridurre le interruzioni non programmate.

Affidabilità elevata La capacità di ridurre la frequenza dei guasti del
sistema.

Modello di distribuzione a disponibilità elevata
Il modello di distribuzione a disponibilità elevata (High Availability, HA) fornisce una tolleranza di errore per
i server, i servizi e i database di IQ Bot.
La seguente figura mostra i componenti di IQ Bot e del data center.

In questo esempio, i server di IQ Bot e di Microsoft SQL Server hanno la ridondanza HA.
• Più utenti hanno accesso al cluster di IQ Bot tramite browser web. I browser web comunicano con il

cluster di IQ Bot attraverso il bilanciamento del carico.
• Più Bot Runners comunicano con il cluster di IQ Bot attraverso il bilanciamento del carico.
• La condivisione di file di Server Message Block (SMB) e Microsoft SQL Server archiviano dati dal cluster

di IQ Bot.
• Microsoft SQL Server utilizza la ridondanza attraverso la sincronizzazione della replica in Microsoft SQL

Server in cluster.

Vantaggi Mantiene la disponibilità quando gli errori del server
si verificano all'interno di un singolo data center.

Svantaggi Non fornisce protezione contro le interruzioni di
corrente del data center.

Casi di utilizzo Piccole e medie imprese che non richiedono il
ripristino di emergenza su più siti.

Modello di distribuzione con ripristino di emergenza
Il modello di distribuzione con ripristino di emergenza (Disaster Recovery, DR) utilizza cluster a disponibilità
elevata (High Availability, HA) distribuiti su un'area geografica.
Il ripristino di emergenza (DR) è un metodo in cui le due configurazioni di data center ad alta disponibilità
(HA) sono separate geograficamente. Il vantaggio aggiuntivo di una configurazione HA in una singola
posizione è che, in caso di emergenza localizzata, il data center rimosso fisicamente riprende a funzionare
con tempo di inattività minimo.
Prerequisiti
Prima di eseguire il DR di IQ Bot, esamina i seguenti prerequisiti:
• Attiva le porte in entrata e in uscita.
• Aggiungi tutti i nomi host nelle voci del file host per tutti i nodi.
• Verifica che i database primario e secondario siano sincronizzati.
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• Automation Anywhere Control Room e IQ Bot devono essere installati su entrambi i siti DR primario
(attivo) e secondario (passivo).

• Durante il passaggio dal server primario a quello secondario, verifica quanto segue:
• Se il database secondario dispone dell'autorizzazione di sola lettura, il database primario dispone

dell'autorizzazione di lettura/scrittura.
• Se il database secondario dispone dell'autorizzazione di lettura/scrittura, il database primario dispone

dell'autorizzazione di sola lettura.

Il seguente schema mostra la configurazione DR di IQ Bot:

In questo esempio, tutti i server hanno la ridondanza.
• Più utenti hanno accesso al cluster di IQ Bot tramite browser web. I browser web comunicano con i

cluster di IQ Bot attraverso il bilanciamento del carico.
• Più Bot Runners comunicano con il loro cluster di IQ Bot attraverso il bilanciamento del carico.
• La condivisione di file di Server Message Block (SMB) e Microsoft SQL Server archiviano dati dal cluster

di IQ Bot. Entrambi i server vengono replicati in modo asincrono nel sito di backup con ripristino di
emergenza.

• Microsoft SQL Server utilizza la ridondanza attraverso la sincronizzazione della replica con Microsoft SQL
Server in cluster sul sito di ripristino di emergenza primario.

Per il ripristino di emergenza nell'ambiente di IQ Bot:
• Distribuisci un secondo cluster HA di IQ Bot in un data center aggiuntivo in una posizione geografica

separata.
• In caso di guasto del sito primario, esegui manualmente il ripristino di emergenza. Consulta Panoramica

della procedura di failover del ripristino di emergenza alla pagina 1124.

Nota:  quando si verifica un failover in un sito di backup, è possibile che le modifiche molto recenti
apportate nel sito primario vengano perse.

Vantaggi Fornisce continuità operativa in presenza di
interruzioni di corrente o perdite del data center.

Svantaggi Comporta un aumento del carico operativo.

Per ulteriori informazioni sul benchmarking del ripristino di emergenza di IQ Bot On-Premises, contatta il
Customer Success Manager (CSM) o il Partner Enablement Manager (PEM).
IQ Bot On-Premises Disaster Recovery benchmarking (A-People login required)

Requisiti di configurazione del ripristino di emergenza (DR)
Quando configuri i data center abilitati per il ripristino di emergenza (Disaster Recovery, DR) di IQ Bot,
assicurati che le condizioni elencate siano soddisfatte.

Requisiti di configurazione del ripristino di emergenza

• Replica asincrona: configura la replica asincrona piuttosto che sincrona tra i siti DR per tutti i servizi
di supporto. Ciò assicura che la replica fuori sito non influisca sulle prestazioni del sito primario.

• Dominio AD: assicurati che sia disponibile lo stesso dominio di Active Directory sia per i siti primari sia
per quelli di backup.
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• Domini del sito: assicurati che le macchine dei dispositivi e Control Room del sito di backup siano
membri dello stesso dominio delle macchine e Control Room del sito primario.

• Licenze: assegna licenze mobili agli utenti in modo che possano accedere ai dispositivi nel sito di
backup.

• Servizi del sito di backup: arresta i servizi di Control Room presso il sito di backup fino a quando non
saranno necessari.

• Configurazioni del sito: assicurati che le macchine presso il sito primario e il sito di backup abbiano
la stessa specifica e la stessa configurazione. Ciò include Control Room, Bot Runners, dispositivi
associati e credenziali di accesso. Questo è necessario per garantire un livello di servizio uguale durante
un'interruzione di corrente.

Nota:  i programmi vengono archiviati in UTC e quindi eseguiti allo stessa ora indipendentemente dalla
posizione fisica e dalle impostazioni di fuso orario del server.

Dettagli della replica del database

La configurazione della replica del database per il ripristino di emergenza è un'estensione della
configurazione a disponibilità elevata. Questa configurazione richiede l'uso di gruppi di disponibilità Always
On.
• Configura la replica del sito primario in modalità di Commit sincrono.
• Configura la replica del sito di ripristino in modalità di Commit asincrono. La modalità Commit

asincrono assicura che la latenza e l'affidabilità del data center non influiscano sulle prestazioni e sulla
disponibilità del sito primario.

• Non configurare la replica del sito di ripristino in modo da offrire eventuali servizi di database fino
all'attivazione di un failover di ripristino.

Modalità di errore

Con la replica asincrona esiste la possibilità che una transazione che si verifica nel sito primario non
raggiunga la replica del sito di ripristino prima che si verifichi l'errore.

Nota:  questa possibilità di perdere le transazioni più recenti si applica a tutte le soluzioni applicative
automatizzate DR utilizzando la replica asincrona, non solo la soluzione Automation Anywhere.

La distribuzione richiede una rigorosa coerenza tra sedi geografiche distanti. Il Commit sincrono
configurato tra repliche con latenza significativa ha un effetto dannoso su tutte le operazioni di Control
Room.
Per evitare che gli elementi di lavoro vengano elaborati due volte quando si verifica un errore, alcuni
elementi di lavoro in attesa di consegna a un dispositivo vengono posti in stato di errore. Ciò assicura che
possano essere rivisti manualmente e contrassegnati come pronti per essere elaborati o completati come
appropriato.

Panoramica della procedura di failover del ripristino di emergenza
È descritta la panoramica della procedura di failover per il ripristino di IQ Bot dopo un'emergenza.
Completa la distribuzione del ripristino di emergenza su due siti separati geograficamente, dove un sito è
primario (attivo) e l'altro è un sito di backup (passivo). Il ripristino di emergenza viene eseguito sul sito di
backup remoto.
La procedura è identica a prescindere dal fatto che il passaggio sia da primario a secondario (ripristino) o
da secondario a primario.
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Se i nodi di IQ Bot con errori sono ancora disponibili:
1. Chiudi tutti i servizi di IQ Bot presso il sito primario.
2. Esegui il failover di tutti database correlati a IQ Bot utilizzando gli strumenti di database.
3. Esegui il failover della condivisione di Server Message Block (SMB) utilizzando gli strumenti appropriati

per rendere scrivibile la condivisione file SMB del sito di ripristino.
4. Avvia i servizi di IQ Bot presso il sito di ripristino.
5. Attendi finché l'interfaccia web di IQ Bot non è disponibile.
6. Accedi all'interfaccia web come amministratore.
7. Dopo che il sito di ripristino funziona come sito primario, configura un sito secondario sostitutivo.

Utilizzando gli strumenti di database, imposta la replica dal sito primario di ripristino al sito secondario
sostitutivo.

Ridefinire un sito DR duplicato
Dopo aver ripristinato un sito secondario (backup) come sito primario (produzione), definisci un nuovo sito
DR secondario.
Il sito di ripristino è operativo come nuovo sito di produzione.
Il processo di trasferimento dell'attività a un sito di produzione primario (attivo) e al sito secondario
(backup) dipende dallo stato del sito primario originale.
• Se l'ambiente di produzione precedente diventa nuovamente disponibile, completa la seguente

procedura per tornare al sito DR primario originale.
a) Ripristina/Replica il file system e il database DR rispettivamente nel file system e nel database di

produzione originali.
b) Visualizza il nuovo IQ Bot DR primario (produzione).
c) Verifica che il nuovo ambiente DR primario (produzione) stia funzionando regolarmente.
d) Interrompi i servizi di IQ Bot DR sul sito di ripristino DR.
e) Definisci la replica tra il nuovo IQ Bot DR primario (produzione) e quello DR secondario (standby)

(DB e NAS).

• Se il rendering del vecchio ambiente di produzione DR primario è completamente inutilizzabile a causa
dell'emergenza, ridefinisci un nuovo sito DR secondario (standby). Per ridefinire i siti DR primari e
secondari, completa la seguente procedura.
a) Ripristina/Replica i dati del database e del file system dall'ambiente DR al nuovo ambiente di

produzione.

Non è necessaria un'ulteriore procedura. Sono stati ripristinati i siti DR primario e secondario.
• Non è necessario eseguire di nuovo l'utilità di attivazione del bot. L'attivazione avviene solo quando IQ

Bot viene distribuito nei siti del cluster DR.
• Per eventuali emergenze successive, è necessario eseguire solo la query del database sul database di

IQ Bot DR secondario (standby). Ciò è necessario perché la replica tra il sito DR primario (produzione)
e il sito DR secondario (standby) sovrascrive i dati di Bot Runner del sito DR secondario nel database di
tale sito con i dati di Bot Runner del sito DR primario (produzione).

• Analogamente, viene creata la mappatura tra Bot Runner DR primario e DR secondario. Utilizza la
stessa mappatura per tutte le successive emergenze o le esercitazioni fittizie.
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Migrazione a Automation 360

Important:  See Upgrade launchpad (A-People login required) for a self-guided experience tailored to your
Control Room version, with resources and support to migrate to Automation 360.

La migrazione è il processo di trasferimento di dati e bots da Enterprise 11 o Enterprise 10 a Automation
360. La migrazione include, a titolo esemplificativo, la replica e l'aggiornamento del database e dell'archivio
esistenti, la conversione dei bots in formato Automation 360 e la migrazione delle istanze di apprendimento
per IQ Bot e dei dashboard per Bot Insight.
Automation 360 è un'unica piattaforma per forza lavoro digitale integrata nativa per il cloud progettata per
offrire flessibilità e agilità. La migrazione a questa piattaforma offre vantaggi quali un time-to-value più
rapido, agilità aziendale e TCO inferiore.
Per ulteriori informazioni, consulta Informazioni su Automation 360 on page 11.

Cosa si intende per migrazione

Il processo di migrazione copia tutte le entità Enterprise 11 o Enterprise 10 come utenti, ruoli, armadietti
e bots su Automation 360. In questo modo non è più necessario ricreare tutte queste entità in Automation
360. Il processo di migrazione fa sì anche che non si tralasci un'entità che potrebbe essere necessaria per
eseguire un bot dopo la migrazione. Tutte le entità Enterprise 11 o Enterprise 10 sono pronte per l'uso in
Automation 360 dopo la migrazione, ad eccezione di bots e MetaBots.
Quando i dati Enterprise 11 o Enterprise 10 vengono migrati, i bots vengono copiati come file .atmx e i
MetaBots vengono copiati come file .mbot. Converti questi bots e MetaBots in formato Automation 360
prima di utilizzarli.
La migrazione include anche la migrazione delle istanze di apprendimento IQ Bot e dei dashboard Bot
Insight.

Migrazione di IQ Bot Durante la migrazione dei bots Enterprise 11 o
Enterprise 10, esegui la migrazione delle istanze
di apprendimento IQ Bot. Prima di avviare la
migrazione del IQ Bot, assicurati che l'ambiente
Automation 360 sia installato e configurato per
l'uso. La migrazione IQ Bot implica la migrazione dei
bots creati per utilizzare IQ Bot, nonché le istanze
di apprendimento IQ Bot che sono state addestrate
per l'estrazione dei dati.
Utilizza le procedure di aggiornamento del server
del IQ Bot e dell'istanza di apprendimento per
spostare le informazioni sul nuovo sistema. Consulta
Migrazione a Automation 360 IQ Bot on page 1339.

Migrazione di Bot Insight La migrazione dei dati Bot Insight e dei dashboard
viene eseguita come parte del processo di
migrazione generale. Si tratta di clonare il database
Bot Insight (separato dal database della Control
Room Enterprise 11) e utilizzare l'utilità di pre-
migrazione per estrarre i metadati del dashboard
(widget, layout e così via).
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Fasi di migrazione

La migrazione prevede tre fasi principali, come illustrato nell'immagine seguente:

1. Controlla la preparazione alla migrazione on page 1135
Analizza i bots utilizzando il Bot Scanner ed esamina il report generato per verificare lo stato di
preparazione alla migrazione.

2. Preparazione della nuova Control Room per la migrazione on page 1174
Scegli il modello di distribuzione (Cloud, On-Premises o abilitato al cloud) e richiedi le licenze di
migrazione. Prepara la Control Room e l'ambiente per la migrazione.

3. Migrazione e la convalida dei bots on page 1212
Converti i bots Enterprise 11 o Enterprise 10 nel formato Automation 360. Dopo la migrazione, verifica
che i bots convertiti siano eseguiti correttamente e aggiorna i bots secondo necessità in base ai report
di migrazione o alla fase di test.

Note:  Se si verifica un errore durante la migrazione da Enterprise 11 o Enterprise 10, potrebbe
essere necessario esaminare o eseguire alcune azioni sui bots. Consulta Messaggi di migrazione on
page 1302.

Strumenti utilizzati per la migrazione

I seguenti strumenti sono disponibili per la migrazione:

Bot Scanner Bot Scanner esegue la scansione dei bots (TaskBots
e MetaBots) esistenti e genera report. Questi report
forniscono informazioni sui comandi e sulle variabili
utilizzati in questi bots e su quanti di questi comandi
e variabili sono supportati per la migrazione in
Automation 360 (lo scanner era precedentemente
denominato "utilità di pre-migrazione").
Panoramica di Bot Scanner on page 1158

Bot Migration Wizard Integrato nella Control Room Automation 360,
questo strumento guida nel processo di conversione
dei bots nel formato Automation 360 compatibile
dopo aver completato i passaggi preliminari.
La procedura guidata ti consente di eseguire la
migrazione di più bots (TaskBots e MetaBots) e dei
relativi dipendenti bots.
La procedura guidata di migrazione esegue la
migrazione di un bot solo se tutti i componenti
utilizzati in bot sono supportati per la migrazione in
Automation 360.
Migrazione dei bots di Enterprise on page 1216
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Utilità di migrazione Cloud Questo strumento ti consente di caricare tutti
i dati Enterprise 11 su Cloud di Automation
Anywhere. Dopo aver caricato correttamente i dati
su Cloud, viene creata la Cloud Control Room e
tutti i dati caricati sono disponibili per l'uso nella
Control Room. L'utilità esegue la migrazione dei
dati dall'archivio Control Room (bots, relative
dipendenze e Credential Vault) e dal database
Control Room (utenti, ruoli, pianificazioni, code e
impostazioni Control Room).
Caricamento dei dati di Enterprise 11 utilizzando l'utilità
di migrazione Cloud on page 1183

Utilità di migrazione dei dati del log di audit Questa utilità ti consente di esportare i dati dei log
di audit dalla Control Room Enterprise 11 a un file
JSON. Incolla il file JSON nell'archivio Automation
360, quindi migra i dati del log di audit.

Utilità di pre-migrazione Bot Insight Questa utilità ti consente di esportare i metadati
del dashboard Enterprise 11 Bot Insight (widget e
layout) e i profili del dashboard come file zip. Incolla
il file zip nell'archivio Automation 360 per migrare i
dashboard Bot Insight.
Esportazione di dashboard Enterprise 11 Bot Insight per
la migrazione on page 1194

Quali elementi vengono migrati e quali no

Enterprise 10: Esamina le informazioni sugli elementi che vengono migrati e su quelli che non vengono
migrati per i diversi modelli di distribuzione On-Premises.

Enterprise 10 Elemento migrato a On-Premises

Bots e relative dipendenze Sì

Credential Vault Sì

Ruoli Sì

Utenti Sì

Pianificazioni (disabilitate dopo la migrazione a
Automation 360)

Sì

Audit logs No

Cronologia del controllo delle versioni dei Bots No

Dispositivi e pool di dispositivi No

Log del file system No

IQ Bot (la migrazione di IQ Bot richiede un
processo separato)

No

Enterprise 11: Esamina le informazioni sugli elementi che vengono migrati e quelli che non vengono
migrati per i diversi modelli di distribuzione.
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Enterprise 11 Cloud On-Premises

Utenti, ruoli, variabili di
credenziali e armadietti

Sì Sì

Bots e relative dipendenze Sì Sì

Pianificazioni (disabilitate dopo
la migrazione a Automation
360)

Sì Sì

Code del carico di lavoro Sì Sì

Dashboard di Bot Insight
• Dashboard pubblicato
• Dashboard predefinito e

personalizzato

Sì Sì

Dati transazionali dei Bots
• Dati transazionali dello

spazio di lavoro privato (bots
che vengono eseguiti con
licenza Bot Creator)

• Dati transazionali dello
spazio di lavoro pubblico
(bots che vengono eseguiti
con licenza Bot Runner)

Sì Sì

Dati operativi per l'esecuzione
di Bot

Sì Sì

Licenze Yes (Requires unique license
GUID)

Sì

Istanze di apprendimento IQ
Bot (la migrazione dei IQ Bot
richiede un processo separato)

No Sì

Audit logs No Sì

Pool di dispositivi No Sì

Dati cronologici Sì Sì

Impostazioni di Control Room No Sì

Cronologia del controllo delle
versioni dei Bots

No No

Dispositivi No No

Log del file system No No

Flussi di lavoro No No

Dashboard Bot Insight per bots
importati

Sì No

Dati del file AASettings.xml No No
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Scelta del percorso di migrazione

Dopo aver verificato lo stato di preparazione alla migrazione per la versione corrente, scegli il percorso di
migrazione in base al modello di distribuzione Automation 360 che soddisfa i requisiti aziendali.
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Versione attualmente in uso Avvio della migrazione

Enterprise 11 • Enterprise 11 to Automation 360 Cloud (using
the Cloud Migration Utility)
Workflow map: Click the following
schematic image to view this migration
workflow in an interactive visual

format:
1. Migrating from Enterprise 11 to Automation

360 Cloud

• Enterprise 11 to Automation 360 On-Premises

Workflow map: Click the following
schematic image to view this migration
workflow in an interactive visual

format:
1. Migrating from Enterprise 11 to Automation

360 On-Premises

• Migrazione manuale ad Automation 360 Cloud
• Migrazione manuale ad Automation 360 on-

premise
• Da Enterprise 11 al programma abilitato al cloud
• Da Enterprise 11 ad Automation 360 su Linux

CentOS
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Versione attualmente in uso Avvio della migrazione

Enterprise 10 Enterprise 10 to Automation 360 On-Premises

Workflow map: Click the following
schematic image to view this migration
workflow in an interactive visual

format:
1. Migrating from Enterprise 10 to Automation 360

On-Premises

Se disponi di un numero elevato di bots, puoi eseguire Automation 360 ed Enterprise 11 o 10 in parallelo.
Questo metodo ad ambiente doppio consente di eliminare i tempi di inattività. Scegli una delle procedure
seguenti in base al modello di distribuzione:

Se desideri utilizzare questi ambienti doppi Utilizza questa procedura

Enterprise 11 e Automation 360 Cloud Enterprise 11 e Automation 360 Cloud in parallelo

Enterprise 11 e Automation 360 On-Premises Enterprise 11 e Automation 360 on-premise in
parallelo

Enterprise 10 e Automation 360 On-Premises Enterprise 10 e Automation 360 on-premise in
parallelo

Altre risorse

Le risorse seguenti possono aiutare gli utenti nell'utilizzo di Automation 360:
• Upgrade launchpad (A-People login required): Provides a self-guided experience tailored to your Control

Room version, with resources and support to migrate to Automation 360.
• Migration resource center: Accesso a più risorse di migrazione, tra cui video, modelli di progetti e

informazioni di alto livello da un'unica posizione.
• Automation Anywhere University: RPA Training and Certification (A-People login required): Accesso al

percorso di apprendimento Migrazione ad Automation 360.
Utilizzo di Automation 360 Automation Anywhere University per l'apprendimento pratico, progettato per
gli sviluppatori principianti e avanzati. Opzioni di formazione condotte da istruttori disponibili.

• Automation 360 Migration FAQ
• XML path is not working which works fine in Enterprise 11

© 2023 Automation Anywhere. All rights reserved.     1132

https://docs.automationanywhere.com/category/v10-onprem-migration
https://docs.automationanywhere.com/category/v10-onprem-migration
https://upgrade.automationanywhere.com/readiness
https://www.automationanywhere.com/products/automation-360/migration
https://university.automationanywhere.com
https://www.automationanywhere.com/assets/automation-360-migration-faq.pdf
https://https://apeople.automationanywhere.com/s/article/A360MIG-XML-xpath-is-not-working-which-works-fine-in-v11/s/article/Error-parsing-the-SQL-Instance-name-while-upgrading


    Automation Anywhere - Migrazione a Automation 360

Related tasks
Aggiornamento alla versione di Automation 360 più recente on page 1063
Se stai già utilizzando Automation 360 On-Premises, puoi aggiornare alla versione più recente di
Automation 360.

Procedure di migrazione consigliate
Per completare correttamente la migrazione, rivedi le procedure consigliate e le linee guida relative al
processo di migrazione (migrazione di bots, Bot Insight e IQ Bot) e su Bot Scanner, Control Room e
Credential Vault.

Bot Scanner

Quando usi il Bot Scanner per verificare lo stato di preparazione alla migrazione, prendi in considerazione
le seguenti procedure consigliate:
• Crea una copia dell'archivio della Control Room Enterprise 11 o Enterprise 10.

Crea una copia dell'archivio della Control Room sul dispositivo sul quale desideri eseguire il Bot Scanner.
• Utilizza la versione più recente del Bot Scanner.

Vengono rilasciate nuove versioni di Bot Scanner insieme a ogni lancio di Automation 360. La versione
più recente è aggiornata con il supporto di più comandi e funzionalità Enterprise 11 o Enterprise 10, che
aiutano a decidere quando eseguire la migrazione.

• Esegui sempre il Bot Scanner sulla copia dell'archivio Enterprise 11 o Enterprise 10.
• Non usare bots da più istanze della Control Room. Ad esempio, se disponi di due istanze della Control

Room, non copiare i bots da entrambe le istanze della Control Room nella stessa posizione e utilizza la
suddetta posizione nel Bot Scanner per eseguire la scansione di tali bots.

• Esamina attentamente il report del Bot Scanner.
Il report consente di determinare quali bots sono pronti per la migrazione e quando sarà disponibile il
supporto per i comandi e le funzionalità non supportati. La comprensione delle tempistiche dei comandi
e delle funzionalità non supportati consente di decidere quando eseguire la migrazione.

Control Room e Credential Vault

• Crea e salva un backup dell'archivio e database della Control Room Enterprise 11 o Enterprise 10 prima
di installare Automation 360.
Utilizza questo backup per eseguire la migrazione in modo che non vi siano interruzioni per
l'automazione di Enterprise 11 o Enterprise 10 esistente.

• Non modificare il nome del database quando ripristini il backup del database Enterprise 11 o Enterprise
10.

• Per la migrazione, non utilizzare un computer su cui è già installato Automation 360.
• Configura Credential Vault in modalità Express.

Costruzione di Bot

Quando costruisci nuovi bots in Enterprise 11 o Enterprise 10, tieni a mente le considerazioni seguenti in
modo da rendere la migrazione a Automation 360 più semplice.
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Note:  Queste considerazioni saranno di aiuto principalmente agli utenti che usano un doppio ambiente
(eseguendo Enterprise 11 o Enterprise 10 e Automation 360 in parallelo).

• Non usare Microsoft Internet Explorer per creare automazioni, poiché Microsoft pianifica di interrompere
il supporto per Internet Explorer da giugno 2022 su alcuni sistemi operativi.

• Usa l'automazione basata su oggetti ogni volta possibile: Per esempio, usa il comando Object Cloning
invece del comando Web Recorder.

• Utilizza AISense Recorder al minimo, poiché la migrazione di questo registratore non è ancora
supportata in Automation 360.

• Non usare Citrix Automation, comandi Internet Connection, Apache Flex, Adobe Flash o il browser
Microsoft Edge (legacy) in Object Cloning, poiché non sono supportati in Automation 360.

Migrazione di Bot

• Assegna il ruolo e le autorizzazioni di migrazione richiesti agli utenti che avvieranno il processo di
migrazione e i Bot Runners che verranno utilizzati per la migrazione bot.

• Assegna le autorizzazioni necessarie ai dispositivi che verranno utilizzati per la migrazione del bot.
• Installa Bot Agent sui dispositivi che verranno utilizzati per la migrazione bot.
• Verifica l'installazione di Automation 360 prima di utilizzare Bot Migration Wizard per eseguire la

migrazione dei bots.
Crea ed esegui un bot campione prima di utilizzare Bot Migration Wizard. In questo modo, si garantisce
che i prerequisiti di sistema di Automation 360, quali la registrazione del dispositivo, gli aggiornamenti
delle credenziali e Auto Login siano soddisfatti.

• Avvia la migrazione con un processo aziendale per il quale tutti i bots sono completamente pronti per la
migrazione.

• Verifica la presenza di eventuali aggiornamenti manuali necessari per i  migrati.
Esamina i messaggi relativi ai bots migrati per verificare se sono necessari aggiornamenti affinché i bots
migrati eseguano correttamente questi bots. L'elenco dei bots che richiedono aggiornamenti dopo la
migrazione è disponibile nella scheda Azione richiesta del report Bot Scanner.

Operazioni successive alla migrazione

• Convalida il bots migrato.
Pianifica un orario dedicato per la convalida e assicurati che la migrazione dei bots sia avvenuta
correttamente. Non eliminare i bots in formato Enterprise 11 o Enterprise 10 fino a quando non
completi la convalida per confermare che questi bots vengano eseguiti correttamente dopo la
migrazione.

• Crea tutti i nuovi bots in Automation 360 al termine della migrazione.
• Se dopo la migrazione sono stati aggiornati bots in Enterprise 11 o Enterprise 10, esegui nuovamente la

migrazione di questi bots.

Migrazione di Bot Insight

• Esegui il backup e il ripristino del database Enterprise 11 Bot Insight prima di installare Automation 360.
• Quando ripristini il database, utilizza le stesse credenziali usate per il database Enterprise 11.
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Migrazione di IQ Bot

• Scarica il Database Migration Assistant compatibile con la versione di Automation 360.
• Crea backup dei database Enterprise 11.
• Interrompere l'elaborazione, la formazione e la convalida dei documenti in Enterprise 11.
• Prepara un nuovo ambiente per IQ Bot e l'installazione di Database Migration Assistant.
• Ripristina i database Enterprise 11 di cui è stato eseguito il backup in posizioni diverse.
• Esamina il file di log di Database Migration Assistant.
• Se l'indirizzo della Control Room Automation 360 è nuovo, esegui la procedura di pulizia delle

informazioni di registrazione dell'applicazione nel database IQ Bot.
• Esegui la migrazione delle istanze di apprendimento una alla volta. Non inserire tutte le istanze di

apprendimento in un file iqba.

Strumenti per la migrazione
Abbiamo spostato le informazioni presenti in questa pagina in altre pagine. Per ulteriori informazioni,
consulta i seguenti link.
• Per una panoramica della migrazione, incluse le informazioni precedentemente contenute in questa

pagina, consulta Migrazione a Automation 360 on page 1126.
• Per informazioni su Bot Scanner, consulta Panoramica di Bot Scanner on page 1158.
• Per informazioni su Bot Migration Wizard, consulta Bot Migration Wizard on page 1213.

Controlla la preparazione alla migrazione
Esegui le attività in questo flusso di lavoro per verificare se sei pronto a eseguire la migrazione a
Automation 360 da Enterprise 11 e Enterprise 10.

1. Verifica la versione corrente della piattaforma Enterprise 11 o Enterprise 10.
Verifica della versione di Enterprise 11 o Enterprise 10 per la migrazione on page 1141

2. Verifica se la versione corrente di Enterprise 11 o Enterprise 10 è supportata per la migrazione.
Versioni Control Room supportate per la migrazione on page 1136

3. Confronta Automation 360 e le funzionalità Enterprise 11 e Enterprise 10.
Matrice di confronto delle funzionalità per Automation 360 on page 722

4. Esamina le informazioni sulla mappatura dei packages e delle variabili per comprendere come
i comandi e le variabili Enterprise 10 o Enterprise 11 differiscono dai packages e dalle variabili
Automation 360 equivalenti.
Mappatura dei pacchetti per la migrazione on page 1247 | Mappatura delle variabili per la migrazione on
page 1279

5. Utilizza Bot Scanner per analizzare i bots e identificare i comandi e le variabili utilizzati nei bots che
sono supportati per la migrazione in Automation 360.
Scan Enterprise 11 or 10 bots using Bot Scanner on page 1160
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6. Analizza il report generato da Bot Scanner.
Analisi del report di Bot Scanner per la migrazione on page 1162

Preparazione della nuova Control Room per la migrazione on page 1174

Versioni Control Room supportate per la migrazione
Rivedi le versioni Enterprise 11 e Enterprise 10 certificate e supportate per la migrazione a Automation
360 On-Premises e al Cloud pubblico o privato su Microsoft Windows Server. Una versione Enterprise 11 o
Enterprise 10 certificata significa che le principali funzionalità di quella versione della piattaforma e i bots
sviluppati sulla versione sono supportati in Automation 360.
Il supporto a più versioni Enterprise 11 e Enterprise 10 verrà aggiunto per un certo periodo di tempo.

Remember:  Le versioni Enterprise 11 e Enterprise 10 non elencate nelle tabelle seguenti non sono
certificate per la migrazione. Se utilizzi una versione non certificata per la migrazione e desideri eseguire la
migrazione a Automation 360, esegui prima l'aggiornamento a una versione certificata, quindi procedi con
la migrazione.

If you are migrating from OEM products such as IBM RPA, contact Automation Anywhere Support: Open a
support case (A-People login required)

Migrazione On-Premises: Versioni Enterprise 11 e 10 supportate

Se utilizzi una delle versioni seguenti Enterprise 11 e Enterprise 10, puoi eseguire la migrazione. La tabella
elenca anche la versione base di Automation 360 da cui è supportata la versione specifica Enterprise 11 o
Enterprise 10.
Versioni di Enterprise 11 supportate | Versioni di Enterprise 10 supportate

Versioni Enterprise 11 per la migrazione On-Premises

Versioni di Enterprise 11 Versioni di Control Room supportate Versioni di base supportate di Automation 360

11.3.5 • 11.3.5.5
• 11.3.5.4
• 11.3.5.3
• 11.3.5.2
• 11.3.5.1
• 11.3.5

• v.23 e successive
• v.24 e successive
• v.24 e successive
• v.23 e successive
• v.16 e successive
• v.18 e successive

11.3.4 • 11.3.4.7
• 11.3.4.6
• 11.3.4.5
• 11.3.4.4
• 11.3.4.3
• 11.3.4.2
• 11.3.4.1
• 11.3.4

• v.25 e successive
• v.23 e successive
• v.24 e successive
• v.23 e successive
• v.16 e successive
• v.20 e successive
• v.19 e successive
• v.17 e successive
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Versioni di Enterprise 11 Versioni di Control Room supportate Versioni di base supportate di Automation 360

11.3.3 • 11.3.3.5
• 11.3.3.3
• 11.3.3.2
• 11.3.3.1
• 11.3.3

• v.23 e successive
• v.16 e successive
• v.22 e successive
• v.21 e successive
• v.17 e successive

11.3.2 • 11.3.2.5
• 11.3.2.4
• 11.3.2.2
• 11.3.2.1
• 11.3.2

• v.23 e successive
• v.15 e successive
• v.09 e successive
• v.09 e successive
• v.08 e successive

11.3.1 • 11.3.1.11 (superiore a 11.3.1)
• 11.3.1.11 (superiore a 11.3.1.2)
• 11.3.1.10
• 11.3.1.9
• 11.3.1.8
• 11.3.1.7
• 11.3.1.5
• 11.3.1.4
• 11.3.1.2
• 11.3.1.1
• 11.3.1

• v.23 e successive
• v.23 e successive
• v.22 e successive
• v.17 e successive
• v.19 e successive
• v.15 e successive
• v.17 e successive
• v.20 e successive
• v.22 e successive
• v.21 e successive
• v.09 e successive

11,3 11,3 v.10 e successive

11.2.1 • 11.2.1.6
• 11.2.1.5
• 11.2.1.4
• 11.2.1.3
• 11.2.1.2
• 11.2.1.1
• 11.2.1

• v.23 e successive
• v.20 e successive
• v.15 e successive
• v.11 e successive
• v.11 e successive
• v.23 e successive
• v.23 e successive

11,2 11,2 v.19 e successive

11,1 • 11.1.2
• 11.1.0

• v.22 e successive
• v.23 e successive

Versioni Enterprise 10 per la migrazione On-Premises

Versioni di Control Room Enterprise
10supportate

Versioni di base supportate di Automation 360

10.7.5 v.16 e successive

10.5.141 v.22 e successive

10.5.113 v.18 e successive
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Versioni di Control Room Enterprise
10supportate

Versioni di base supportate di Automation 360

10.5.112 v.18 e successive

10.5.17 v.18 e successive

10.5.16 v.12 e successive

10.5.15 v.16 e successive

10.5.14 v.22 e successive

10.5.13 v.20 e successive

10.5.12 v.22 e successive

10.5.11 v.15 e successive

10.5.9 v.17 e successive

10.5.0 v.12 e successive

10.3.11 v.25 and later

10.3.5 v.25 and later

10.3.0 v.22 e successive

Migrazione Cloud: Versioni di Enterprise 11 supportate

Se utilizzi una delle versioni Enterprise 11 seguenti, puoi eseguire la migrazione Cloud.
All supported Enterprise 11 Control Room versions listed in this table also support Bot Insight migrations.

Versioni di Enterprise 11 Versioni di Control Room supportate

11.3.5 • 11.3.5.5
• 11.3.5.4
• 11.3.5.3
• 11.3.5.2
• 11.3.5.1
• 11.3.5
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Versioni di Enterprise 11 Versioni di Control Room supportate

11.3.5 Certificazione per le versioni del programma di
installazione IBM:
• 11.0.0.10.iFix004 (superiore a Automation

Anywhere 11.3.5.4)
• 11.0.0.10.iFix003 (superiore a Automation

Anywhere 11.3.5.3)
• 11.0.0.10.iFix002 (superiore a Automation

Anywhere 11.3.5.2)
• 11.0.0.10.iFix001 (superiore a Automation

Anywhere 11.3.5.1)
• 11.0.0.10 (superiore all'aggiornamento JDK

Automation Anywhere 11.3.5)
• 11.0.0.9 (superiore a Automation Anywhere

11.3.5)

11.3.4 • 11.3.4.6
• 11.3.4.5
• 11.3.4.4
• 11.3.4.3
• 11.3.4.2
• 11.3.4.1
• 11.3.4

11.3.3 • 11.3.3.5
• 11.3.3.3
• 11.3.3.2
• 11.3.3.1
• 11.3.3

11.3.2 • 11.3.2.5
• 11.3.2.4
• 11.3.2.2
• 11.3.2.1
• 11.3.2
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Versioni di Enterprise 11 Versioni di Control Room supportate

11.3.1 • 11.3.1.11 (superiore a 11.3.1.2)
• 11.3.1.11 (superiore a 11.3.1)
• 11.3.1.10 (superiore a 11.3.1)
• 11.3.1.9 (superiore a 11.3.1)
• 11.3.1.7 (superiore a 11.3.1.2)
• 11.3.1.7 (superiore a 11.3.1)
• 11.3.1.5 (superiore a 11.3.1)
• 11.3.1.4 (superiore a 11.3.1.2)
• 11.3.1.4 (superiore a 11.3.1)
• 11.3.1.2
• 11.3.1.1
• 11.3.1

11,3 11,3

11,2 • 11.2.1.6
• 11.2.1.5
• 11.2.1.4
• 11.2.1.3
• 11.2.1.2
• 11.2.1.1
• 11.2.1
• 11,2

11,1 • 11.1.2
• 11.1.0

Migrazione Cloud: Tipi di distribuzione del database supportati

La migrazione Cloud è supportata per i seguenti tipi di distribuzione del database:

Tipo di distribuzione del
database

Database contenuto Database non contenuto

Microsoft SQL Server su AWS
RDS

Sì Sì

Microsoft SQL Server su Azure
PaaS

Sì Sì

Microsoft SQL Server nel cloud
Google

Sì Sì

Versioni database supportate di Microsoft SQL Server
Per i tipi di distribuzione del database elencati nella tabella precedente, puoi ospitare una delle versioni
di database Microsoft SQL Server seguenti. Tutte le edizioni Database (Enterprise, Express, Standard,
Developer (2019) e GCP Cloud SQL) sono supportate per la migrazione.
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Database Crea Versione del file Sistema operativo
supportato

12.0.2000.8 2014.120.2000.8Microsoft SQL Server
2014 12.0.6024.0 2014.120.6024.0

Windows Server 2012
R2 Standard e versione
successiva

Microsoft SQL Server
2016

13.0.5026.0 2015.131.5026.0 Windows Server 2012
R2 Standard e versione
successiva

Microsoft SQL Server
2017

14.0.1000.169 2017.140.1000.169 Windows Server 2012
R2 Standard e versione
successiva

Microsoft SQL Server
2019

15.0.2000.5 2019.150.2000.5 Windows Server 2016 e
versione successiva

Verifica della versione di Enterprise 11 o Enterprise 10 per la migrazione
La migrazione a Automation 360 è supportata per molte versioni certificate di Enterprise 10 ed Enterprise
11. Prima di avviare il processo di migrazione, verifica la versione attuale della piattaforma, quindi verifica
se tale versione è attualmente supportata per la migrazione.

Verificare la versione attuale della piattaforma

La versione attuale della piattaforma è disponibile in Control Room e nel Enterprise Client. Verifica la
versione della piattaforma da Control Room:
1. Accedi a Enterprise 11 Control Room.
2. Fai clic sull'icona Guida in alto a destra di Control Room per verificare il numero di versione, elencato

nella parte inferiore del menu.
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Verifica delle versioni supportate per la migrazione

Dopo aver verificato quale versione di Enterprise 11 o Enterprise 10 è stata distribuita dall'organizzazione,
controlla quali versioni sono supportate per la migrazione.
1. Vai alla pagina seguente: Versioni Control Room supportate per la migrazione on page 1136.
2. Verifica se la versione è supportata per la migrazione.

In questa pagina sono elencate le versioni supportate per la migrazione Cloud e On-Premises.

Versione della piattaforma non presente nell'elenco delle versioni supportate

Sebbene consigliamo di iniziare la migrazione dopo aver verificato se la versione in uso è supportata per
la migrazione, puoi comunque eseguire Bot Scanner per determinare quale dei bots e dei relativi comandi
sono pronti per la migrazione. Ciò ti aiuterà a pianificare la migrazione poiché saprai quando i bots e i
comandi attualmente non supportati saranno supportati nella prossima versione.

Funzionalità non supportate per la migrazione
Esamina le funzioni che non sono supportate per la migrazione da Enterprise 11 o Enterprise 10 a
Automation 360.

Features not yet supported

Le seguenti funzioni non sono ancora supportate per la migrazione:
• Migration of audit logs from Enterprise 11 is not supported on Cloud deployments.
• In Enterprise 11, if bots were using the Before-After string operation with the OR logical operator and

operation output resulted in an empty string, then the output displayed as an empty string.
However in Automation 360, if the output of such an operation results in an empty string, the value
used in the End before text string operation is ignored and the result displays in the output.
For example, in the text email:user@outlook.com, if the value in the Before operation is email:
and the value in After operation is user, the results differ based on product version:
• Enterprise 11 displays an empty string as the output.
• Automation 360 displays user@outlook.com as the output.

• In Enterprise 11, if users select internal variables for the window titles; but not used in the bot, after
migration, these internal variables are also migrated to Automation 360.

• In migrated bots, if you are using OLE DB Driver version 18 or later and when you export SQL Server
Database with bit columns to a CSV file, the bit value of -1 is returned instead of 1 for string value
TRUE.
Fixed in: v.27

• When you migrate bots using SAP > Select item by index command, incorrect index is displayed in
the migrated bot.
Fixed in: v.26

• Bots that include the Terminal Emulator package are migrated only to Advanced Technology and not
to Legacy Technology.
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• Quando si esegue la migrazione a un bot utilizzando l'action Manage Window Controls, l'ultima cifra del
valore dell'altezza non è disponibile dopo la migrazione. Tuttavia, il bot verrà eseguito correttamente.
Fixed in: v.26

• Quando una sessione di Excel è attiva in SAP, si avvia un processo Excel corrispondente in background.
In questo scenario, Automation 360 utilizza lo stesso processo Excel iniziato da SAP. Quando si esegue
un bot per automatizzare i dati del foglio di calcolo, Automation 360 elabora la prima richiesta con
successo. Tuttavia, durante l'esecuzione, se l'Excel viene chiuso e viene inviata una successiva richiesta
di automatizzazione dei dati del foglio di calcolo, Automation 360 non elabora la richiesta perché il
processo Excel è ancora in fase di accesso da parte di SAP. Pertanto, non viene attivata la finestra
corretta per automatizzare i dati del foglio di calcolo.
Fixed in: v.26

• If a bot is using the Structured text type field in the PDF > Extract text action, some of the
characters might not be extracted correctly.
Fixed in: v.25

• After migration, the Before, Before and/or after, and After options in the String > Extract text
action does not match the case in a string.
Fixed in: v.25

• After migration, bots that were using the Get text > All lines action in Enterprise 11 will display only
24 rows of lines in the Terminal Emulator.
Fixed in: v.26

• Migrating bots with Get Total Rows command in SAP GUI returns values as Float string type instead
of an Integer type after migration.
Fixed in: v.26

• If you are a Bot Creator or a Bot Runner user, you might not be able to view the Review messages
displayed in the Bot Assistant without having the View migration permission.
Fixed in: v.26

• When you use counter as a variable in a nested loop, the parent loop functions properly but the child
loop does not run as expected.
Fixed in: v.27

• Bots with SAP packages cannot pick and convert window titles that include "*" (asterisk) character.
These window titles are not converted to currently active window names after migration.
Fixed in: v.26

• Bot deployment might fail when you run migrated bots with the SAP > Get Property command. This
issue occurs because of the following reason: In Enterprise 11, property name is case in-sensitive.
During migration, property name is changed to being case sensitive, so bot deployment fails when the
case of property name does not match.
Fixed in: v.26

• When you send an email through Exchange Web Services (EWS), the format of the email output do
not have line breaks , the content appears tampered, and the entire content of the email appears in a
single line.
Fixed in: v.26

• I dispositivi Enterprise 11 o Enterprise 10 Bot Runner e Bot Creator non sono inclusi nel processo di
migrazione, pertanto non vengono migrati a Automation 360.
L'Bot Agent Automation 360 sostituisce Enterprise 11 e. Enterprise 10 Enterprise Client Utilizza Bot
Agent per collegare un dispositivo a Automation 360 Control Room ed eseguire i bots sui dispositivi
collegati.

• When you run a migrated bot with the option Validate if attachment is missing option checked, and
if the attachment is missing when you send the email, the bot might not run successfully.
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• Flussi di lavoro, trigger, cronologia di controllo delle versioni di bots e registri del file system.
• Migrazione di bots Enterprise 11 che utilizzano Subversion Version Control per il controllo delle versioni.
• Migration of Enterprise 11 On-Premises Control Room to Automation 360 Cloud service on GCP using

the Cloud Migration Utility is not supported.
• Control Room che utilizza Oracle Database.

Fixed in: v.26
• Migrazione di dati Bot Insight e altre entità come utenti, ruoli, pianificazioni e variabili delle credenziali

quando Automation 360 viene installato utilizzando un nuovo database.
• Funzioni Taglia, Copia, Incolla e Ctrl+A sullo schermo del terminale quando si usa Terminal Emulator.

Fixed in: v.27
• Uso di una variabile all'interno di una variabile (ad eccezione delle variabili di tipo valore) in un bot.

Ad esempio, se un bot contiene $variable1$, dove $variable1$ contiene $variable2$ e $variable2$
contiene il valore effettivo,per questo bot non è possibile eseguire la migrazione.

• Utilizzo di un valore fisso e di una variabile per specificare la posizione dell'indice, ad esempio
$v_ArrVar(1$RowIndex$,1)$.

• Possibilità di acquisire immagini dalla finestra del tempo di esecuzione quando viene eseguito un bot.
• I bots Enterprise 11 o Enterprise 10 che utilizzano un valore stringa in una variabile utilizzata nel

comando If insieme all'operatore '<' o '=' sono migrati a Automation 360. Tuttavia, questi bots rilevano
errori quando vengono eseguiti in Automation 360.

• Il comando If o il comando Loop che usano l'operatore <, >, <= o >= con variabili che contengono un
valore di stringa rilevano un errore dopo la migrazione.
Ad esempio, se si dispone di un bot che contiene una variabile con il valore abcd e utilizza l'operatore
>, il bot rileva un errore quando viene eseguito dopo la migrazione perché le variabili del tipo stringa
non dovrebbero utilizzare gli operatori <, >, <= o >=.

• Comando Object Cloning che automatizza le seguenti applicazioni:
• Applicazioni Flash
• Applicazione Web in esecuzione sul browser Edge-Legacy

• I bots Enterprise 11 o Enterprise 10 hanno potuto eseguire una macro Microsoft Excel dal file Microsoft
Excel disponibile nella cartella XLSTART quando la macro viene richiamata da un altro file Excel che
non contiene tale macro. Dopo la migrazione, questi bots non sono in grado di eseguire le macro
disponibili in un altro Excel

• Il simbolo della freccia non viene visualizzato in Automation 360 Bot editor.
Quando il simbolo della freccia viene utilizzato in bots Enterprise 11 o Enterprise 10, il Bot editor non
visualizza alcun simbolo dopo la migrazione, con un'eccezione. L'eccezione è che quando il simbolo
viene utilizzato in più comandi IF/ELSE, il Bot editor visualizza la variabile $String:FormFeed$ invece del
simbolo freccia.

Funzioni non supportate con soluzione alternativa

È possibile eseguire la migrazione di bots con le seguenti funzioni se queste vengono aggiornate in base
alla soluzione specificata:
• If you have created triggers, indexes, views and such custom Database objects in addition to the

existing standard objects created in the Enterprise 11 Control Room, you might not be able to restore
the exported data to Cloud using the Cloud Migration Utility. If you need help to identify such objects,
contact Automation Anywhere support: Open a support case (A-People login required).
Soluzione: Disable the additionally created Database objects before exporting data to the Cloud.
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• In Enterprise 11, if bots were using a window title value or variable that contained leading spaces, after
migration, the bots will be unable to select the corresponding window.
Soluzione: Remove the leading spaces from the window title value or variable and then run the bots.

• When you use the Recorder to capture an object, select HTML Tag, HTML InnerText, and HTML
type properties in Search Criteria, or migrate a bot with similar properties selected in Search Criteria,
the bot fails to identify or locate the object and perform the selected action.
Soluzione: Modify the DomXpath according to the controls you capture or add more properties in
Search Criteria.

• When your bot has some error, you add the Try/Finally block around those actions and insert one
more action in the Finally block. When you save and run the bot, you will see the Bot error dialog
shows the wrong error line number within the Finally block.
Soluzione: If you are using Try and Finally without using Catch action, the Bot error dialog will not
show the correct line number. Instead, use Try/Catch, the Try action handles the error and sends
execution to Catch with line number and description. This would give the correct line number within
the Finally block.

• Nota: Issue applies only to v.22 and earlier (as this is fixed in v.23, see Migration of non-credential vault
variables). Comando Esegui logica che utilizza le variabili delle credenziali come input per una logica di
un MetaBot
Soluzione: Bots che utilizzano il comando Esegui logica che trasferisce gli attributi Credential Vault
da un TaskBot a una logica MetaBot possono essere migrati a Automation 360. Il nome delle credenziali
e il nome dell'attributo vengono visualizzati nei campi della riga corrispondente del bot migrato.
Se è stata eseguita la migrazione utilizzando il database Enterprise 11 ripristinato, viene creato un
locker equivalente in Automation 360 per le variabili delle credenziali utilizzate nel bot Enterprise 11.
Scegli una delle opzioni seguenti per eseguire correttamente i bots migrati:
• Opzione 1: Trasferisci le variabili di tipo credenziale.

1. Crea una variabile di tipo di credenziale nei bots figli come variabili di input.
2. Nell'action Esegui del package Task Bot del bot padre, aggiorna i campi del valore di input per

utilizzare gli attributi Credential Vault per la variabile di tipo di credenziale creata per il bot figlio
(corrispondente alla logica di MetaBot).

• Opzione 2: Trasferisci i valori delle credenziali come valore globale.
1. Crea il valore globale in Automation 360 per l'uso delle credenziali nel comando Esegui logica

in Enterprise 11.
2. Nell'action Esegui del package Task Bot del bot padre, aggiorna i campi del valore di input

per utilizzare i valori globali per la variabile di tipo di credenziale creata per il bot figlio
(corrispondente alla logica MetaBot).

Se non è stato utilizzato il database Enterprise 11 ripristinato durante l'installazione di Automation
360, crea l'armadietto richiesto per le variabili delle credenziali utilizzate nel bot Enterprise 11 prima di
eseguire i passaggi precedenti.

Note:  Automation 360 fornisce una protezione avanzata consentendo di assegnare gli attributi
Credential Vault solo alle variabili del tipo di credenziale. Ciò limita la gestione non protetta degli
attributi Credential Vault che potrebbero essere stati assegnati a variabili di tipo non credenziale.
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• When you create DLLs with different functions, if you use the same filename for DLLs and add them to
multiple MetaBots, after migration, if a TaskBot is using the Logic of these MetaBots, an error occurs
during execution.
The error occurs because the DLL sessions are based on the DLL filenames, and only the session of the
first DLL will be active during execution. Any function called from subsequent DLLs will not be present
in the first DLL session that is active.
For example, consider that MetaBot1 is using a DLL that has function1 and MetaBot2 is using a DLL that
has function2, and both the DLLs have the same filename test.dll. After migration, when you run a
TaskBot that uses MetaBot1 Logic and MetaBot2 Logic, the DLL session of MetaBot1 Logic is activated
and function1 runs successfully. However, when the MetaBot2 Logic is run, the corresponding DLL is
not activated because the session with the same DLL filename is already active, and function2 is not
present in the DLL of MetaBot1 Logic, which results in an error.
Soluzione: Depending on your requirements, you can perform one of the following workarounds:
• Before migrating the bots, ensure that you rename the DLL filename of one of the DLLs, update the

references to the DLL function in MetaBots Logic, and then migrate the bots.
• After migrating the bots, change the session name in the Create DLL session box of the Open DLL

action and then update the same DLL session name in the related If action for the DLL Session
does not exists condition and the Run DLL action.

• In Enterprise 11, if a MetaBot was using Microsoft.Exchange.WebServices.dll to use
Microsoft Exchange services, after migration, when you use the Get DLL details option in
the DLL Run function, an error is encountered. The error is because, in Automation 360, the
Microsoft.Exchange.WebServices.dll is not automatically installed in the global assembly
cache (GAC) on your device.
Soluzione: You must manually install the Microsoft.Exchange.WebServices.dll in GAC on
your device and then use the Get DLL details option.
Consulta How to: Install an assembly into the global assembly cache .

• In Enterprise 11, if a bot was using the Log To File action and you entered text greater than 1000
characters in the Enter text to log field, then after migration, the bot will encounter an error.
Soluzione: Ensure that the you configure the text as a variable, and then use this variable in the
Enter text to log field instead of entering the static text.

• In Enterprise 11, if you used the Loop action to open the same Excel sheet multiple times without
closing it, after migration, an error occurs. The error occurs because, in Automation 360, only one Excel
session can be active at a time.
Soluzione: In the Loop action, ensure that you use the Close action to close the Excel session before
opening the Excel sheet again with the same session name.

• In Enterprise 11, if bots were using the String > Replace action to find a carriage return line feed
(CRLF) character and replace it with another character, after migration, the output might not be the
same as the output seen in Enterprise 11.
Soluzione: In the Find string option, instead of the Enter (LF) variable, use the Newline (CRLF)
variable.

• After migration, bots that were using the Log To File action to log files are using the LF character
instead of the CRLF character for new lines.
Soluzione: Use the $String:Newline$ variable to use the CRLF character in the migrated bots.

• If a MetaBot Logic (for example, Logic A) is referenced to a TaskBot or another MetaBot Logic and
if Logic A was renamed or moved from one logic folder to another within the same MetaBot, after
migration, the TaskBot or MetaBot Logic does not work when it calls for Logic A.
Soluzione: In the TaskBot or MetaBot Logic which calls for Logic A, update the name or path to
reference to Logic A.
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• If a bot is using the Browser > Download files action to download files from a URL, some files
whose URLs have special characters or require Windows native authentication access might not
download properly.
Soluzione: Use the Browser > Open action instead.

• Automated migration to Automation 360 Cloud.
Soluzione: puoi utilizzare il processo manuale per eseguire la migrazione a un'istanza abilitata al cloud.
Consulta Preparazione per abilitare la migrazione da Enterprise 11 a Automation 360 on page 1201.

• When you insert XML > Insert node as an attribute using a variable, the bot migration might fail.
Soluzione: Insert the attribute by providing the direct value instead of a variable.

• When you run migrated bots that open URL without the protocol information (such as http, https, or
file), the web page might not open properly.
Soluzione: Ensure that you add the appropriate protocol information to the URL.

• If a MetaBot Logic was using a DLL file that used classes without a namespace, after migration, any
TaskBot that uses the MetaBot Logic will not work.
Soluzione: Manually update the DLL file to include namespace for classes.

• After migrating bots, an error is seen when using FTP actions on bots that are using comma in the
filenames and when using the Delete files and Delete folder FTP actions on bots that are using colon in
the filenames.
Soluzione: Ensure that you remove comma in the filenames before using the FTP actions and colon in
the filenames before using the Delete files and Delete folder FTP actions.

• If a bot was using the Send action to send an email with attachments where the path for the
attachments were variables, the bot will either fail to execute or ignore the attachment.
Soluzione: Replace variables with the paths for the attachments.

• I bots Enterprise 11 o Enterprise 10 rilevano un errore dopo la migrazione quando questi bots utilizzano
il comando Esegui logica per eseguire una logica MetaBot e la posizione della logica viene specificata
fino alla cartella che contiene tale logica. Ad esempio, ipotizzando che tu voglia eseguire Logic1
disponibile nella posizione D:Metabots\Logics\Finance. Se specifichi solo D:Metabots\Logics
\Finance invece del percorso completo (D:Metabots\Logics\Finance\Logic1) della logica, si
verifica un errore.
Soluzione: aggiornare il percorso di tutta la logica MetaBot al percorso completo nei bots Enterprise 11
o Enterprise 10 prima della migrazione.

• I MetaBots Enterprise 11 o Enterprise 10 che utilizzano la variabile delle credenziali per trasferire un
valore numerico come input a una funzione DLL.
Soluzione:
1. aggiorna la funzione DLL per utilizzare il parametro di input della stringa tipo.
2. Elimina i comandi dai MetaBots che trasferiscono il parametro di input del tipo numerico alla

funzione DLL.
3. Aggiungi i comandi in MetaBots per trasferire i parametri di input del tipo stringa alla funzione DLL.
4. Migra i TaskBots e MetaBots pertinenti.
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• Se stai eseguendo la migrazione a Automation 360 Cloud e hai configurato SAML come tipo di
autenticazione in Enterprise 11, il processo di migrazione modifica il tipo di autenticazione in base al
tipo di autenticazione del database Control Roomper Automation 360 Control Room.
Soluzione: per configurare SAML come tipo di autenticazione per Cloud Control Room dopo la
migrazione, esegui queste operazioni:
1. Elimina l'utente utilizzato per configurare SAML in Enterprise 11 da Automation 360.
2. Crea un altro utente con le autorizzazioni richieste e utilizzalo per configurare SAML in Automation

360.

• Applicable to v.24 and earlier:Migration from Enterprise 10 to Automation 360 Cloud.
Soluzione: Eseguire la migrazione a una versione di Enterprise 11 supportata per la migrazione a
Automation 360 Cloud e quindi eseguire la migrazione a Automation 360 Cloud.

• bots Enterprise 11 che utilizzano Exchange Web Services (EWS) per inviare e-mail utilizzando il
comando Send Email, rilevano un errore dopo la migrazione a Automation 360
Soluzione: Creare i seguenti valori globali in Automation 360 e aggiorna i bots migrati per utilizzare
EWS in tutte le azioni:
• AAE_EmailSettings_auth
• AAE_EmailSettings_host
• AAE_EmailSettings_port
• AE_EmailSettings_ssl

I valori per questi valori globali devono essere quelli specificati in Enterprise 11.
• Il comando Loop o il comando If che utilizzano le condizioni della data per confrontare le date in formati

diversi riscontrano un errore dopo la migrazione. Ad esempio, una data in formato mm/gg/aaaa non
funziona con una data in formato mm/gg/aaaa hh:mm:ss.
Soluzione: Aggiornare le date con un formato diverso allo stesso formato.

• Un bot non può utilizzare una variabile o un oggetto contenente dati superiori a 64 KB. Ad esempio,
se hai acquisito una tabella da un sito Web utilizzando il comando Object Cloning e l'oggetto acquisito
contiene dati superiori a 64 KB. I Bots che contengono tali oggetti rilevano un errore dopo la
migrazione.
Soluzione: Rimuovere i dati indesiderati o copiare i dati in un file CSV o di testo e utilizzare l'action
Leggi del package CSV/TXT.

• La migrazione non viene eseguita per l'azione a cui manca il valore Credential Vault in Control Room.
Soluzione: crea il valore Credential Vault in Automation 360 prima della migrazione e avvia
nuovamente la migrazione utilizzando Bot Migration Wizard.

Migrazione dei bots con stato N/D

I report Bot Scanner mostrano lo stato dei bots che contengono comandi non supportati e che non
possono essere migrati come N/D. È possibile effettuare la migrazione di questi bots modificandoli sul
computer Enterprise 11 Enterprise 10 come specificato nella seguente tabella:

Messaggio Migrazione di bot non ancora supportata a causa di bot figlio che utilizzano
comandi non supportati.

Descrizione Un bot figlio che utilizza un comando attualmente non supportato per la
migrazione non può essere migrato. Di conseguenza i bots padre che utilizzano
questo bot figlio non possono essere migrati.
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Azione Per migrare questi bots padre, rimuovi i riferimenti al bot figlio dal bot padre ed
effettua poi la migrazione del bot padre.
Per visualizzare i comandi non supportati utilizzati nel bots figlio, vai all'elenco dei
bots che non possono essere migrati e fai clic sul nome del bot figlio.

Messaggio La migrazione di "Clonazione dell'oggetto" con "HTML (Edge)" non è ancora
supportata

Descrizione Il browser Legacy Microsoft Edge non è supportato in Automation 360, pertanto
la migrazione di bots configurati con questo browser in non è supportata.

Azione Aggiorna i bots Enterprise 11 utilizzando altri browser supportati, come Google
Chrome, Firefox, Internet Explorer o il browser Chromium Microsoft Edge.

Messaggio La migrazione di MetaBot non è supportata. Il file schermata non esiste. Correggi
il bot e riprova.

Descrizione La logica MetaBot fa riferimento a una schermata che non esiste nel MetaBot.

Azione Per migrare il MetaBot, aggiungere nuovamente la schermata o rimuovere i
riferimenti alle schermate inesistenti.

Messaggio La migrazione del comando "Funzionamento variabili" in cui i tipi di variabili non
corrispondono non è supportata. Correggi il bot e riprova.

Descrizione Il bot Enterprise 11 o Enterprise 10 utilizza il comando Funzionamento
variabili dove i tipi di variabile delle variabili utilizzate non sono gli stessi.

Azione Aggiorna il comando Funzionamento variabili nei bots Enterprise 11 o
Enterprise 10 per assicurare che le variabili di riferimento siano dello stesso tipo.

Messaggio La migrazione del comando "Funzionamento variabili" in cui la variabile non esiste
non è supportata. Correggi il bot e riprova.

Descrizione il bot Enterprise 11 o Enterprise 10 fa riferimento a una variabile inesistente nel
comando Funzionamento variabili.

Azione Crea una variabile con lo stesso nome e tipo oppure rimuovi il comando che fa
riferimento alla variabile inesistente.

Messaggio La migrazione del comando "If" in cui la variabile non esiste non è supportata.
Correggi il bot e riprova.

Descrizione Il bot Enterprise 11 o Enterprise 10 fa riferimento a una variabile inesistente nel
comando Se.
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Azione Crea una variabile con lo stesso nome e tipo oppure rimuovi il comando che fa
riferimento alla variabile inesistente.

Messaggio La migrazione del comando "ElseIf" in cui la variabile non esiste non è
supportata. Correggi il bot e riprova.

Descrizione Il bot Enterprise 11 o Enterprise 10 fa riferimento a una variabile inesistente nel
comando Else If.

Azione Crea una variabile con lo stesso nome e tipo oppure rimuovi il comando che fa
riferimento alla variabile inesistente.

Messaggio La migrazione del comando "Loop" in cui la variabile non esiste non è supportata.
Correggi il bot e riprova.

Descrizione bot Enterprise 11 o Enterprise 10 fa riferimento a una variabile inesistente nel
comando Loop.

Azione Crea una variabile con lo stesso nome e tipo oppure rimuovi il comando che fa
riferimento alla variabile inesistente.

Messaggio La migrazione di "Esegui un'attività" con percorso bot definito tramite
"AAApplicationPath" non seguito da un percorso della cartella di archivio
valido non è supportata. Correggi il percorso del task bot nel bot 11.x e migra
nuovamente.

Descrizione Il bot Enterprise 11 o Enterprise 10 utilizza un percorso non valido nel comando
Esegui attività del bot figlio.

Azione Per eseguire la migrazione di questo bot, modifica il bot Enterprise 11 per
garantire un percorso valido per il bot figlio dopo AAApplicationPath.

Messaggio La migrazione di "If - TaskSuccessful" con percorso bot definito utilizzando
"AAApplicationPath" non seguito da un percorso di cartella di archivio valido non è
supportata. Correggi il percorso del task bot nel bot 11.x e migra nuovamente.

Descrizione Il bot Enterprise 11 o Enterprise 10 utilizza un percorso non valido all'interno della
condizione Se > Attività riuscita del bot figlio.

Azione Aggiorna il bot Enterprise 11 o Enterprise 10 per garantire al bot figlio
un percorso valido seguito da una struttura di cartelle appropriata dopo
AAApplicationPath.

Messaggio La migrazione di "If - TaskUnsuccessful" con percorso bot definito utilizzando
"AAApplicationPath" non seguito da un percorso di cartella di archivio valido non è
supportata. Correggi il percorso del task bot nel bot 11.x e migra nuovamente.
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Descrizione Il bot Enterprise 11 o Enterprise 10 utilizza un percorso non valido all'interno della
condizione Se > Attività non riuscita del bot figlio.

Azione Aggiorna il bot Enterprise 11 o Enterprise 10 per garantire al bot figlio
un percorso valido seguito da una struttura di cartelle appropriata dopo
AAApplicationPath.

Messaggio La migrazione di "ElseIf - TaskSuccessful" con percorso bot definito utilizzando
"AAApplicationPath" non seguito da un percorso di cartella di archivio valido non è
supportata. Correggi il percorso del task bot nel bot 11.x e migra nuovamente.

Descrizione Il bot Enterprise 11 o Enterprise 10 utilizza un percorso non valido all'interno della
condizione Altrimenti se > Attività riuscita del bot figlio.

Azione Aggiorna il bot Enterprise 11 o Enterprise 10 per garantire al bot figlio
un percorso valido seguito da una struttura di cartelle appropriata dopo
AAApplicationPath.

Messaggio La migrazione di "ElseIf - TaskUnsuccessful" con percorso bot definito utilizzando
"AAApplicationPath" non seguito da un percorso di cartella di archivio valido non è
supportata. Correggi il percorso del task bot nel bot 11.x e migra nuovamente.

Descrizione Il bot Enterprise 11 o Enterprise 10 utilizza un percorso non valido all'interno della
condizione Altrimenti se > Attività non riuscita del bot figlio.

Azione Aggiorna il bot Enterprise 11 o Enterprise 10 per garantire al bot figlio
un percorso valido seguito da una struttura di cartelle appropriata dopo
AAApplicationPath.

Messaggio La migrazione del comando "Funzionamento variabili" che reimposta la variabile di
sistema "$WorkItemResult$" non è supportata.

Descrizione Il ripristino della variabile di sistema $WorkItemResult$ non è supportato per il
comando Funzionamento variabili.

Azione Utilizza l'operazione Stringa > Assegna e assegna una stringa vuota alla
variabile di sistema $WorkItemResult$ invece di reimpostarla.

Messaggio La migrazione di "Finestre - Chiudi tutte le finestre aperte" non è ancora
supportata.

Descrizione Se è stato utilizzato il comando Chiudi con l'opzione Tutte le finestre aperte
selezionata in un bot, non è possibile eseguire la migrazione di tale bot.

Azione Aggiorna il bot Enterprise 11 o Enterprise 10 in modo che non utilizzi l'opzione
Tutte le finestre aperte prima della migrazione
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Messaggio La migrazione di "If - ObjectProperties" con il campo
"OCObjectPlay_PropertyInfo_ReviewMessage" di tipo "String" non è ancora
supportata.

Descrizione Il bot Enterprise 11 o Enterprise 10 utilizza un oggetto nel comando If > Object
Properties che ha una delle proprietà con dimensioni superiori a 64 KB.

Azione Per la migrazione di questo bot puoi eseguire una delle seguenti azioni:
• Elimina il valore della proprietà di dimensioni superiori a 64 KB nel comando If

> Object Properties.
• Memorizzare il valore della proprietà che supera i 64 KB in un file di testo.

Quindi, creare una variabile che legge il valore da questo file. Assegna questa
nuova variabile alla proprietà corrispondente nel comando If > Object
Properties.

Messaggio La migrazione di "ElseIf - ObjectProperties" con il campo
"OCObjectPlay_PropertyInfo_ReviewMessage" di tipo "String" non è ancora
supportata.

Descrizione Il bot Enterprise 11 o Enterprise 10 utilizza un oggetto nel comando Else If >
Object Properties che ha una delle proprietà con dimensioni superiori a 64 KB.

Azione Per la migrazione di questo bot puoi eseguire una delle seguenti azioni:
• Per eseguire la migrazione di questo bot, elimina il valore della proprietà di

dimensioni superiori a 64 KB nel comando Else If > Object Properties.
• Memorizzare il valore della proprietà che supera i 64 KB in un file di testo.

Quindi, creare una variabile che legge il valore da questo file. Assegna questa
nuova variabile alla proprietà corrispondente nel comando Else If > Object
Properties.

Messaggio La migrazione di "Loop.Condition - ObjectProperties" con il campo
"OCObjectPlay_PropertyInfo_ReviewMessage" di tipo "String" non è ancora
supportata.

Descrizione Il bot Enterprise 11 o Enterprise 10 utilizza un oggetto nel comando Loop while
> Object Properties che ha una delle proprietà con dimensioni superiori a 64
KB.

Azione Per la migrazione di questo bot puoi eseguire una delle seguenti azioni:
• Per eseguire la migrazione di questo bot, elimina il valore della proprietà di

dimensioni superiori a 64 KB nel comando Else If > Object Properties.
• Memorizzare il valore della proprietà che supera i 64 KB in un file di testo.

Quindi, creare una variabile che legge il valore da questo file. Assegna questa
nuova variabile alla proprietà corrispondente nel comando Else If > Object
Properties.
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Differenze nelle caratteristiche di Automation 360 e Enterprise 11/Enterprise
10
Review how some features and functionalities, such as folder structure, bot deployment, packages,
variables, and MetaBots, are different in Automation 360 as compared with Enterprise 11 and Enterprise
10.

Struttura delle cartelle

La struttura delle cartelle in cui i bots (TaskBots e MetaBots) sono archiviati in Automation 360 è diversa da
quella di Enterprise 11 e Enterprise 10.

Struttura delle cartelle di Automation 360 The bots (TaskBots and MetaBots) are available
in the Automation > Bots. I Bots migrati da
Enterprise 11 o Enterprise 10 sono disponibili
nell'area di lavoro pubblica.
The following image shows the folder structure in
Automation 360

Struttura delle cartelle di Enterprise 11 e
Enterprise 10

Bots (TaskBots only) are available in the My Tasks
folder (Automate > Tasks > My Tasks) and
MetaBots are available in the My MetaBots folder.
L'immagine seguente mostra la struttura delle
cartelle in Enterprise 11:
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Distribuzione di Bot

• Enterprise 11: Quando un bot a bassa priorità è in esecuzione e un bot ad alta priorità viene
distribuito, il sistema mette in pausa il bot a bassa priorità ed esegue il bot ad alta priorità. Dopo che il
bot ad alta priorità viene eseguito, viene ripresa l'esecuzione del bot a bassa priorità.

• Automation 360: La priorità dei bots viene verificata al momento della distribuzione. Quando i bots
sono in coda per un utente Bot Runner, i bots con priorità più alta vengono distribuiti prima dei bots
con priorità più bassa. Tuttavia, se un bot con priorità più bassa è già in esecuzione, i bots con priorità
più alta vengono distribuiti solo dopo che il bot con priorità più bassa completa l'esecuzione.
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Packages

Per la maggior parte dei comandi di Enterprise 11 o Enterprise 10, actions e packages simili o equivalenti
sono disponibili in Automation 360. However, the behavior of some of the Automation 360commands is
different compared with those in Enterprise 11 or Enterprise 10.
• Automation 360 is created afresh to support not only the current but also the future automation needs

of modern enterprises. Accordingly, Automation 360 is built to meet important objectives, such as
providing the following features:
• A standardized, predictable, and scalable platform
• Consistent user experience
• Improved flexibility and security

With Automation 360, we aim to provide these features by employing industry-standard exception
handling, rich support for dedicated data types, and so on.
Because Automation 360 is created afresh, some of the Enterprise 11 capabilities that have been
redesigned in Automation 360 might not have a directly corresponding Automation 360 feature.
However, to ensure that the migrated bots produce output that is identical to that produced by their
corresponding Enterprise 11 bots, we have mapped Enterprise 11 commands to their corresponding
actions in Automation 360.
In instances where a direct mapping between an Enterprise 11 command and an Automation 360 action
is unavailable, we have used "expressions" to ensure that the migrated bots produce output that is
identical to that produced by their corresponding Enterprise 11 bots, without requiring you to manually
update the bots.

Note:  The usage of expressions leads to more number of lines and additional variables in the migrated
bots as compared to their corresponding Enterprise 11 bots.

For information about expressions, see Legacy Automation package on page 1668.
• Per il comando Enterprise 10/Enterprise 11 che utilizza un campo del titolo della finestra configurato

con una variabile definita dall'utente, il processo di migrazione migra il bot aggiungendo l'azione
Imposta titolo appena sopra il rispettivo comando. Automation 360 non consente variabili utente nel
campo Titolo della finestra. Utilizza l'azione Imposta titolo per ottenere lo stesso comportamento.

• In Enterprise 11, quando un bot contiene più di un comando con l'opzione Ridimensiona finestra
selezionata, la finestra viene ridimensionata alle dimensioni specificate dal primo comando. In
Automation 360, la finestra viene ridimensionata ogni volta che il bot incontra un'action con l'opzione
Ridimensiona finestra selezionata. Ciò garantisce che in fase di runtime le dimensioni della finestra
di ciascun action corrispondano alle dimensioni di configurazione di action, migliorando la capacità del
bot di trovare l’oggetto.

• In Enterprise 11 o Enterprise 10, l'indicizzazione di loop della tabella inizia con 1 e procede con
incrementi di 1. Automation 360 inizia l'indicizzazione con 0 e procede con incrementi di 1.

• Il processo di migrazione migra i comandi IF e Loop che contengono diverse condizioni di una variabile.
• I comandi disabilitati sono migrati come segue in base ai diversi modelli di codifica:

• Un comando disabilitato singolarmente (con o senza errori di convalida) viene migrato come azione
disabilitata. Tutte le operazioni sono disabilitate se un comando disabilitato viene migrato a più
operazioni in Automation 360.

• Il comando Gestione errori disabilitata viene migrato al blocco Prova e Cattura disabilitato,
comprese tutte le altre operazioni, a seconda della configurazione.

• Il comando Disabilita loop viene migrato a un'azione Ciclo disabilitato in Automation 360.
• Disabled If command is migrated as a comment so that the migrated bot returns the same result as

that returned by the corresponding Enterprise 10 or Enterprise 11 bot.
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• In Enterprise 11 o Enterprise 10, alcuni comandi dell'operazione Stringa utilizzano i caratteri speciali
Tabulazione, Invio e Separatore. In Automation 360, tali caratteri sono variabili di sistema nel pacchetto
String (Stringa).

Enterprise 10/Enterprise 11 Automation 360

[Tab] (Tabulazione) $String:Tab$

[Enter] (Invio) $String:Enter$

[Separator] (Separatore) $String:Separator$

Consulta String package on page 1881.
• Enterprise 11 o Enterprise 10 fornisce varie impostazioni predefinite come parte della selezione del

titolo di una finestra, che vengono migrate alle rispettive pre-impostazioni in Automation 360.

Opzioni Enterprise 10/Enterprise
11

Automation 360 Opzioni

Finestra attiva corrente Finestra attiva corrente

Desktop • Per il comando Inserisci clic del mouse, utilizza
l'opzione Schermata per titolo finestra.

• Per il comando Inserisci sequenza di tasti, utilizza
l'opzione Finestra attiva corrente.

• For Screen > Capture area, use the Screen for
window title option.

• Per il comando Acquisisci desktop del comando
Screen Capture, utilizza l'azione Acquisisci area del
package Screen con l'opzione Schermata selezionata
dall'elenco disponibile nella scheda Applicazione.

Sfondo Desktop

Barra dei comandi Barra dei comandi

Mappatura dei pacchetti per la migrazione on page 1247

Variabili

Per la maggior parte degli utenti, sistema e variabili di credenziale di Enterprise 11 o Enterprise 10, variabili
di sistema simili o equivalenti sono disponibili in Automation 360. Il comportamento di alcune variabili di
Enterprise 11 o Enterprise 10 è diverso rispetto a Automation 360.
• Per ogni variabile passata come input in Enterprise 11 o Enterprise 10 bot, viene aggiunta una riga

in bot migrato in Automation 360. Ad esempio, se si stanno passando 100 variabili come input in
Enterprise 11 bot, dopo la migrazione, bot ha 100 nuove righe.

• In Enterprise 11 or Enterprise 10, you can use the Session Name field in paired commands to specify
a session name as both a static value and a variable value. For example, you can specify a session
name to open a file or establish a connection. You can then use that same session name as a variable
value in a Loop command. However, migrated bots differentiates between a static value and a variable
value, and handle the values differently after migration. As a result, after you migrate these bots to
Automation 360, you must update the bot to use the correct output Dataset variables in the Loop
command (which is aligned with the Open file session variable). For migrated bots, we recommend
that you configure the session name as a static value or a variable value in all the instances.
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• I comandi Enterprise 11 o Enterprise 10 che memorizzano i valori restituiti nella variabile di sistema
$Clipboard$ non sono supportati in Automation 360. Quando si esegue la migrazione di bots con questa
funzionalità, il processo di migrazione assegna i valori a una variabile temporanea e successivamente
assegna il valore alla variabile di sistema Automation 360 $System:Clipboard$ aggiungendo l'azione
Copia in al pacchetto Appunti.

• Alcuni comandi restituiscono valori alle variabili per un’ulteriore elaborazione. In Enterprise 11 o
Enterprise 10, gli utenti possono memorizzare tali valori in diversi tipi di variabili, mentre in Automation
360, tali valori sono archiviati solo in un tipo specifico di variabile.
Ad esempio, se un comando restituisce un valore a una matrice per una cella specifica, in Automation
360archiviamo il valore in una variabile di stringa temporanea. Di conseguenza, nell’operazione
successiva, memorizziamo il valore temporaneo in una variabile di matrice effettiva per far sì che la
logica di esecuzione di bot rimanga intatta.

• In Automation 360, il simbolo del dollaro singolo ($) è riservato all’uso Automation Anywhere, per cui
tutte le immissioni dell’utente di un simbolo del dollaro singolo vengono sostituite automaticamente con
due simboli del dollaro ($$). Ad esempio, se si dispone di un campo di testo, "Paga $5,00", convertiamo
tale campo in "Paga $$5,00" in Automation 360 in modo che venga visualizzato correttamente agli
utenti.

• In Enterprise 11 o Enterprise 10, i bots possono utilizzare una variabile per specificare il bot figlio che si
desidera eseguire. In Automation 360, la sequenza delle attività viene aggiornata nella cartella Bot. La
tabella seguente fornisce alcuni esempi:

Enterprise 11/ o Enterprise 10 Automation 360

D:\My Documents
\AAE_V11\Automation Anywhere
 Files\Automation Anywhere\My
 Tasks\Migration\$bot_name$

Bots\My Tasks\Migration\$bot_name
$

$AAApplicationpath$\Automation
 Anywhere\My Tasks\Migration\
$bot_name$

Bots\My Tasks\Migration\$bot_name
$

D:\$UserName$\My Documents
\AAE_V11\Automation Anywhere
 Files\Automation Anywhere\My
 Tasks\Migration\$bot_name$

Bots\My Tasks\Migration\$bot_name
$

D:\My Documents
\AAE_V11\Automation Anywhere
 Files\Automation Anywhere\
$bot_path$\$bot_name$

Bots\My Tasks\$bot_path$\
$bot_name$

Mappatura delle variabili per la migrazione on page 1279
Supporto della variabili on page 732

MetaBots

I MetaBots non sono disponibili in Automation 360. Quando si esegue la migrazione di MetaBots Enterprise
11 o Enterprise 10, questi vengono migrati ai TaskBots equivalenti in Automation 360. Questi TaskBots
forniscono output e funzionalità simili ai MetaBots.
Il processo di migrazione migra le DLL e la logica ai bots equivalenti. Il comando Esegui logica viene
convertito nell'operazione Esegui del pacchetto Task Bot. Le DLL in MetaBots utilizzano il comando Esegui
per eseguire una funzione da tale DLL. Dopo la migrazione a Automation 360, ogni comando Esegui
viene convertito nelle azioni Apri, Esegui funzione e Chiudi del pacchetto DLL. Informazioni su quale
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funzione eseguire dalla DLL, quali parametri utilizzare e altri dettagli nel comando Esegui vengono migrati
all'azione Esegui. MetaBots con DLL che utilizzano variabili di credenziali di tipo stringa, carattere o dati
byte possono essere migrati in Automation 360.
Prima di Automation 360 v.17, la variabile del dizionario era usata per fornire parametri di input in bots
migrati che erano soliti aggiungere ulteriori fasi nel bot. A partire dalla v.17, la variabile Entrylist viene
utilizzata per fornire parametri di input in un bot migrato. Ciò riduce il numero di passaggi aggiunti al
botmigrato.
Come viene eseguita la migrazione di MetaBots on page 1223

Panoramica di Bot Scanner
Il Bot Scanner analizza i bots (TaskBots e MetaBots) creati in Enterprise 10 o Enterprise 11 Control Room.
The scanner generates a report summarizing the number of bots, commands, and variables that are ready
for migration and those not yet supported for migration, and provides a recommendation on whether you
are ready for migration.
Puoi anche usare il tasto Bot Scanner per scansionare e identificare bots che usano Internet Explorer e che
possono essere convertiti in un browser supportato. Per ulteriori informazioni, consulta Scansione di bots che
usano Internet Explorer on page 1159.

Note:  Viene rilasciata una nuova versione di Bot Scanner con ogni lancio di Automation 360. Utilizza
la versione più recente di Bot Scanner per monitorare quali comandi e variabili sono supportati per la
migrazione in Automation 360 con ogni aggiornamento. Lo scanner ottiene informazioni sui componenti
Automation Anywhere utilizzati dai clienti e dà priorità al supporto di questi componenti per la migrazione.

Considerazioni per l'uso di Bot Scanner

• Assicurati di essere nella versione Enterprise 10 o Enterprise 11 Control Room supportata per la
migrazione prima di eseguire la scansione dei bots.
Versioni Control Room supportate per la migrazione on page 1136

• Non è necessario installare Automation 360 per eseguire Bot Scanner, ma l'accesso all'archivio
Enterprise 10 o Enterprise 11 è un requisito.

• È necessario eseguire Bot Scanner prima di eseguire qualsiasi procedura di migrazione.

Come funziona Bot Scanner

Bot Scanner legge il contenuto di Enterprise 10 o Enterprise 11 e fornisce un report di riepilogo per
l'analisi. Lo scanner suggerisce se eseguire o non eseguire la migrazione immediata e un tempo stimato di
disponibilità (ETA) che indica quando i comandi non supportati saranno supportati in Automation 360.

Note:  Bot Scanner non migra alcun bots o esegue altre azioni. Se non sei pronto per la migrazione, Bot
Scanner identifica i motivi per cui non è possibile eseguire la migrazione dei bots.

I bots (file .atmx e .mbot) vengono scansionati nella posizione specificata e il report di riepilogo fornisce le
seguenti informazioni:
• Il numero di bots sottoposti a scansione
• Il numero di bots che possono e non possono essere migrati in Automation 360
• I comandi e le variabili utilizzati nei bots sottoposti a scansione e supportati in Automation 360
• I comandi che vengono migrati in Automation 360 con alcune modifiche che devono essere riviste
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Note:  Bot Scanner genera il report di riepilogo in formato HTML e un report separato per ciascuno bot in
formato XML.

Report Bot Scanner

Bot Scanner genera i seguenti report che consentono di decidere se avviare la migrazione.

Procedi con la migrazione Questo suggerimento viene generato quando è
possibile migrare il 95% o più del 95% dei bots.
Poiché la maggior parte dei bots sono pronti per la
migrazione, puoi eseguire la migrazione. Potrebbe
essere necessario eseguire alcune operazioni prima
o dopo la migrazione per migrare alcuni dei bots
rimanenti.

Attendere per eseguire la migrazione Questo suggerimento viene generato quando è
possibile migrare meno del 95% dei bots. In
questo caso, devi eseguire l'ultima versione di
Bot Scanner disponibile con la prossima release
di Automation 360 per valutare l'idoneità alla
migrazione.

Condivisione di report Bot Scanner per migliorare l'esperienza

Puoi migliorare l'esperienza della migrazione a Automation 360 condividendo i report generati da Bot
Scanner. Questi report aiutano il nostro team di progettazione a concentrarsi sul supporto dei componenti
che vengono utilizzati più frequentemente dai nostri clienti.

Important:  Manteniamo la privacy dei report condivisi. Non sono incluse informazioni di identificazione
personale (PII) ed è possibile esaminare i report prima di condividerli. Per ulteriori dettagli, contatta il tuo
Customer Success Manager (CSM) o Partner Enablement Manager (PEM).

Scansione di bots che usano Internet Explorer

Puoi usare Bot Scanner per eseguire la scansione dei bots Internet Explorer che devono essere convertiti in
un browser supportato.
Per convertire bots che usano Internet Explorer, il Bot Scanner scansiona tutti i bots e identifica quelli che
usano Internet Explorer in modo da non doverli identificare manualmente. Il Bot Scanner genera quindi un
report che fornisce dettagli sul numero di bots che possono essere convertiti e sul numero di bots che non
possono essere convertiti, insieme ai messaggi di revisione.
Per ulteriori informazioni, consulta Analyze report for Internet Explorer bots on page 783 e Messaggi sulla
conversione o scansione Internet Explorer on page 1336.

Scanning bots that use basic authentication

You can use Bot Scanner to scan bots that are using basic authentication in the Email package and Email
trigger.
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Bot Scanner scans all bots and identifies those that use basic authentication so that you do not have to
identify them manually. The Bot Scanner then generates a report that provides details on the number of
bots that can be updated, along with review messages.
Per ulteriori informazioni, consulta Scan Automation 360 bots for Email action with Basic authentication usage on
page 803 e Basic authentication scanning messages on page 806.

Scan Enterprise 11 or 10 bots using Bot Scanner
Prima di eseguire la migrazione a Automation 360 devi verificare lo stato di preparazione alla migrazione
dei bots. Esegui la scansione dei bots utilizzando Bot Scanner e analizza il report generato per informazioni
sui comandi e le variabili utilizzati in questi bots e su quanti di questi comandi e variabili sono supportati
per la migrazione.
Assicurati di soddisfare i requisiti di sistema per l'utilizzo di Bot Scanner:
• Requisiti hardware

Processore 2,66 GHz o superiore (64 bit)

RAM 2 GB o superiore

Spazio su disco 200 MB

• Requisiti software
Sistemi operativi: Windows 7 o versioni successive (a 32 e a 64 bit)

Puoi anche usare il tasto Bot Scanner per scansionare e identificare bots che usano Internet Explorer e che
possono essere convertiti in un browser supportato.
1. Scarica l'ultima versione di Bot Scanner dal sito del supporto di Automation Anywhere.

a) Accedi a A-People Downloads page (Login required).
b) Fai clic sul link Automation 360 v.xx <Build_number>.

Nel link xx si riferisce al numero di versione. Ad esempio, Automation 360 v.21.
c) Fai clic sulla cartella Installazione e configurazione.
d) Fai clic sul file zip AAE Bot Scanner, quindi fai clic su Scarica sulla barra degli strumenti.

See the following video on how to download Bot Scanner:
2. Estrai i file dal file zip scaricato e fai doppio clic su AAE_Bot_Scanner.exe.

Note:  Assicurati di salvare il file AAE_Bot_Scanner.exe in un percorso che non contenga un
carattere a doppio byte. In caso contrario Bot Scanner rileverà un errore durante l'esecuzione.

Puoi usare il tasto Bot Scanner per scansionare i bots che usano Internet Explorer. Lo scanner genera
quindi un report che fornisce dettagli sul numero di bots che possono essere convertiti e sul numero di
bots che non possono essere convertiti in un browser supportato.
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3. Dalla finestra di dialogo Bot Scanner Automation Anywhere, seleziona una delle seguenti opzioni:
• Migrazione verso Automation 360
• Migrazione + Bots che usano Internet Explorer
• Bots che usano Internet Explorer

La seconda e la terza opzione forniscono statistiche di utilizzo di Internet Explorer che aiutano a
convertire i bots Internet Explorer in un browser supportato.

4. Nella finestra di dialogo Bot Scanner Automation Anywhere, immetti la posizione della cartella
contenente i bots che desideri analizzare nel campo Seleziona percorso archivio.

Important:  Devi creare una copia dell’archivio di Control Room e fornire la posizione della cartella
copiata invece della cartella dell’archivio effettiva.

a) Copia l’archivio di Control Room.
Ad esempio, se la posizione corrente dell'archivio è C:\ProgramData\AutomationAnywhere
\Server Files\Default\Automation Anywhere, devi copiare la cartella Automation
 Anywhere.

b) Incolla l’archivio copiato in una posizione temporanea. Ad esempio, la cartella D:\My Bots.
Devi specificare questa posizione (D:\My Bots) nel campo Seleziona percorso archivio nel
passaggio 3.

5. Immetti la posizione in cui desideri salvare il report generato nel campo Seleziona la cartella di
destinazione.

Note:  I file e le cartelle correlati a Bot Scanner nella cartella di destinazione vengono sovrascritti se è
stata specificata la stessa posizione quando è stata utilizzato Bot Scanner in precedenza.
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6. Immetti un valore nel campo Timeout per specificare il tempo massimo che Bot Scanner deve
impiegare per analizzare un bot.
Se la scansione di un bot richiede più del valore specificato nel campo Timeout, Bot Scanner
interrompe la scansione del bot e procede con la scansione degli altri bots nell'archivio.

7. In the Generate output report for option, select the options for which you need to generate the
report.

Note:  For repositories that are more than 10 GB in size, we recommend that you select only the
Bots option for generating the report.

8. Fai clic su Crea report.
Bot Scanner avvia l'analisi dei bots disponibili nell’archivio.
Bot Scanner visualizza un errore se esegue la scansione di un bot creato utilizzando una versione di
Enterprise Client non supportata. Devi aggiornare il bot a una versione di Enterprise Client supportata
ed eseguire nuovamente la scansione del bot.

9. Optional: Puoi fare clic su Arresta scansione quando Bot Scanner sta analizzando i bots per
annullare l'operazione.
Sono disponibili il report di riepilogo e i singoli report per i bots che sono stati analizzati prima
dell'annullamento dell'operazione.

10. Fai clic su Apri report per aprire il report di riepilogo nel browser predefinito dopo che Bot Scanner
ha completato l'analisi di tutti i bots disponibili nell'archivio.

See the following video on how to use the scanner to scan Enterprise 11 or 10 bots:

• For migration: Analisi del report di Bot Scanner per la migrazione on page 1162
• For IE EOL: Analyze report for Internet Explorer bots on page 783
• For Basic authentication EOL: Scan Automation 360 bots for Email action with Basic authentication usage on

page 803

Related concepts
Panoramica di Bot Scanner on page 1158
Il Bot Scanner analizza i bots (TaskBots e MetaBots) creati in Enterprise 10 o Enterprise 11 Control Room.
The scanner generates a report summarizing the number of bots, commands, and variables that are ready
for migration and those not yet supported for migration, and provides a recommendation on whether you
are ready for migration.
Related reference
Analisi del report di Bot Scanner per la migrazione on page 1162
You can analyze the report generated by the Bot Scanner to get information about the bots (TaskBots
and MetaBots) and processes that can be migrated. Usa il tasto Bot Scanner per decidere se iniziare la
migrazione ora o se preferisci attendere fino a quando saranno supportati più comandi.

Analisi del report di Bot Scanner per la migrazione
You can analyze the report generated by the Bot Scanner to get information about the bots (TaskBots
and MetaBots) and processes that can be migrated. Usa il tasto Bot Scanner per decidere se iniziare la
migrazione ora o se preferisci attendere fino a quando saranno supportati più comandi.
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The Bot Scanner report provides the following information:
• Bots: In the Bot Scanner report, a bot is an individual TaskBot (.atmx) or MetaBot (.mbot) that is used

in other bots.
The Bots tab provides detailed information about bots that can be migrated, those that require action
or review, and those that cannot be migrated.

• Processes: In the Bot Scanner report, a process is a bot that is not used in any other bots and can
include one or more child bots.
The Processes tab provides detailed information about processes that can be migrated, those that
require action or review, and those that cannot be migrated.

The Bot Scanner provides the following important information about the bots and processes:
• Number of bots and processes analyzed
• A high-level summary in the form of boards to indicate the migration status of bots and processes
• Number of bots and processes that you can and cannot migrate to Automation 360
• Commands that are used in the bots and the frequency of usage
• Reasons why bots and processes cannot be currently migrated and frequency of such occurrences
• Actions and reviews required by the users after migration due to change in the behavior of the

commands
• Bots and processes that cannot be migrated and their corresponding error messages
• Number of lines in bots, and total number of lines of each bots associated with a process
• Line number for individual bots and processes that need review or action

Important:  Automation 360 viene aggiornato frequentemente per ottenere l'equivalenza funzionale al
100% con le versioni Enterprise 10 o Enterprise 11. The percentage of bots, commands, and variables that
are supported for migration in Automation 360 will increase until it reaches 100% over the next upcoming
releases. Ciò significa che per ogni funzione eseguita in Enterprise 10 o Enterprise 11 è disponibile una
funzionalità equivalente in Automation 360.
La maggior parte delle funzionalità in Enterprise 10 o Enterprise 11 sono disponibili così come sono;
tuttavia, alcune funzionalità sono implementate in modo diverso per supportare le operazioni Web (senza
client). Per queste funzionalità è necessario modificare il modo in cui i bots vengono scritti.

Bot Scanner è progettato per eseguire la scansione dei bots (TaskBots e MetaBots) creati utilizzando le
versioni Enterprise 10 e Enterprise 11 di Enterprise Client. Il conteggio totale dei file include il numero di
file che sono stati ignorati e non scansionati.
I report sono disponibili nella posizione di output specificata nel campo Seleziona cartella di
destinazione nella finestra di dialogo Bot Scanner Automation Anywhere. The Bot Scanner
generates a summary report (summary.html) and a separate XML for each bot that it scanned. Crea un
report separato per ogni logica disponibile in un MetaBot.
Viene creata una cartella di dati non elaborati contenente i report (in formato XML) per ogni bot
scansionato. Aiuta i nostri ingegneri ad analizzare ulteriormente il processo di migrazione e a intraprendere
azioni correttive, se necessario. Le informazioni che consentono l'identificazione personale dell'utente (PII)
non sono incluse nel report di riepilogo o nei singoli report del botsscansionato.
Se scegli di condividere i report con noi per migliorare il prodotto, comprimi i file nella cartella dei dati
 non elaborati e contatta il responsabile del successo clienti (CSM, Customer Success Manager) o il
responsabile dell'abilitazione partner (PEM, Partner Enablement Manager). Nessun dato viene condiviso
automaticamente con Automation Anywhere.
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Rapporto riepilogativo per tutti i bots

The Bot Scanner utility provides an option to scan for either bots or processes, or bots and processes.
Depending on what you choose, the summary report will contain information about the bots, processes,
or bots and processes. Most of the sections seen in these summary reports will be the same except that
in the bots and processes summary report you will also see an additional All tab that lists all the bots or
processes that are flagged and sorted as Action required, Review required, No review required, and
Non Migratable.

Note:  For generating processes summary report, the maximum repository size that is supported is up to
10 GB.

The summary report provides information about the following:
• whether you can migrate to Automation 360
• the total number of bots scanned
• bots only report that provides information about the bots supported for migration to Automation 360 (in

percentage)
• processes only report that provides information about the processes supported for migration to

Automation 360
• bots and processes combined report that provides information about the bots and processes supported

for migration to Automation 360

Ad esempio, ipotizza che Bot Scanner abbia scansionato 10 bots. Tra 10 bots, se 8 bots sono pronti per
la migrazione a Automation 360, la percentuale di bots che possono essere migrati è dell'80%, mentre la
percentuale di bots che non possono essere migrati allo stato attuale è del 20%.
Reviewing the Bot Scanner report for bots
Considera uno scenario in cui hai scansionato un totale di 1618 bots, di cui il 98% (1614 bots) può essere
migrato in Automation 360. Tuttavia, il 5% dei bots richiede interventi dopo la migrazione, mentre il 2%
(4 bots) non può essere attualmente migrato per determinati motivi. In un simile scenario, il report di Bot
Scanner permette di intraprendere le seguenti azioni:
• Identity the actions and reviews for the remaining 5% of bots so that you can successfully migrate a

majority of your bots and run them in Automation 360 after migration.
• Identificare bots che possono essere migrati in Automation 360 senza alcun intervento manuale.
• Identificare il motivo per cui il 2% dei bots non può essere attualmente migrato e il tempo stimato per

la successiva migrazione. Il motivo potrebbe essere dovuto a comandi e variabili non ancora supportati
in Automation 360.

Reviewing the Bot Scanner report for processes
To review a process message, perform these steps:
1. Click the Processes tab.
2. Click the messages tab that you want to review.
3.

In the Master Task Reference column, click the expand icon ( ) to view the process.
4. Click a process name to view the message.

Consider a scenario where you have a total of 100 processes, of which 99 processes can be migrated to
Automation 360. However, 5 processes require action after migration, 10 processes require review after
migration, and 1 processes cannot be currently migrated due to certain reasons. In un simile scenario, il
report di Bot Scanner permette di intraprendere le seguenti azioni:
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• Identity the actions and reviews for the remaining 15 processes so that you can successfully migrate a
majority of your processes and use them in Automation 360 after migration.

• Identify processes that can be migrated to Automation 360 without any manual intervention.
• Identify the reason why that 1 process cannot be currently migrated and the estimated time for when

you can migrate them later.
Il motivo potrebbe essere dovuto a comandi e variabili non ancora supportati in Automation 360.

L'immagine seguente è un report di esempio di Bot Scanner:

La seguente tabella descrive i vari campi del report di esempio di Bot Scanner (come riportato
nell'immagine precedente):

Campo/
Opzione

Descrizione

1 Provides a summary and status of the migration readiness of your bots. Review
the status of migrated based on the following:
• Green: You can proceed with migration provided that you review the report for

any action or review required for your bots.
• Amber: You have to wait for migrating your bots as the percentage of bots that

are qualified for migration do not meet the migration requirements.
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Campo/
Opzione

Descrizione

2 Provides a summary of the following information for bots:
• Migratable Bots: Provides a summary of the total number of bots that can be

migrated.
• Total Bots: Provides a summary of the total number of bots that were

scanned.
• Action Required: Provides a summary of the total number of bots that

require action after migration to Automation 360.
• Review Required: Provides a summary of the total number of bots that

require review after migration to Automation 360.
• No Review Required: Provides a summary of the total number of bots that

can be migrated to Automation 360 without any manual intervention.
• Non Migratable: Provides a summary of the total number of bots that cannot

be currently migrated to Automation 360.

3 Provides additional resources to ease the migration process.

4 Provides a summary of the following information for processes:
• Migratable Processes: Provides a summary of the total number of processes

that can be migrated.
• Total Processes: Provides a summary of the total number of processes that

were scanned.
• Action Required: Provides a summary of the total number of processes

that require action after migration to Automation 360. Even if a child bot in a
process requires action, the process is flagged as Action Required.

Note:  If a process contains bots where some of them require review and
some others require action, then the process is flagged as Action Required.
The Action Required status takes precedence over the Review Required
status.

• Review Required: Provides a summary of the total number of processes
that require review after migration to Automation 360. Even if a child bot in a
process requires review, the process is flagged as Review Required.

• No Review Required: Provides a summary of the total number of processes
that can be migrated to Automation 360 without any manual intervention. All
the bots in the process can be migrated.

• Non Migratable: Provides a summary of the total number of processes that
cannot be currently migrated to Automation 360. All the bots in the process
cannot migrated.
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Campo/
Opzione

Descrizione

5 • Bots > All > Bots or Processes > All > Bots: Go to this view for a list of
all the bots or processes that are flagged and sorted as Action required,
Review required, No review required, and Non Migratable.

• To view the message for a specific bot that require action or review, click the
bot name.

• To view the message for a specific process that require action or review, click

the expand icon ( ), and then click the task reference name.

Click the message code to view the information about changes in Automation
360 behavior for the command compared with the Enterprise 11 or Enterprise 10
behavior.

Note:  Ogni messaggio include informazioni da rivedere dopo la migrazione. Per
un elenco di questi messaggi, consulta Esaminare i messaggi richiesti on page 1316.
Use the message code (for example R102) to view the specific message quickly.

6 Bots > Action required > Bots or Processes > Action required > Bots: Go
to this view for the list of bots or processes that require action after migration to
Automation 360.
• To view the message for a specific bot that require action, click the bot name.
• To view the message for a specific process that require action, click the expand

icon ( ), and then click the task reference name.

Click the message code to view the information about changes in Automation
360 behavior for the command compared with the Enterprise 11 or Enterprise 10
behavior.

Note:  Ogni messaggio include informazioni da rivedere dopo la migrazione. Per
un elenco di questi messaggi, consulta Esaminare i messaggi richiesti on page 1316.
Use the message code (for example R102) to view the specific message quickly.

7 • Bots > Review required > Bots or Processes > Review required >
Bots: Go this view for a list of the bots or processes that require review after
migration to Automation 360.

• Per visualizzare il messaggio di revisione richiesto per uno specifico bot, fai clic
sul nome del bot.

• To view the review required message for a specific process, click the expand

icon ( ), and then click the task reference name.

Click the message code to view the information about changes in Automation
360 behavior for the command compared with the Enterprise 11 or Enterprise 10
behavior.

Note:  Ogni messaggio include informazioni da rivedere dopo la migrazione. Per
un elenco di questi messaggi, consulta Esaminare i messaggi richiesti on page 1316.
Use the message code (for example R102) to view the specific message quickly.

© 2023 Automation Anywhere. All rights reserved.     1167



    Automation Anywhere - Migrazione a Automation 360

Campo/
Opzione

Descrizione

8 Bots > No review required > Bots or Processes > No review required
> Bots: Go to this view for a list of bots or processes that can be migrated to
Automation 360 without any manual intervention.

9 Bots > Non Migratable > Bots or Processes > Non Migratable > Bots: Go
to this view for a list of bots or processes that cannot be currently migrated to
Automation 360.

10 Bots > Commands : Go to this view for a list of the commands that can be
migrated and the number of times the commands are used across all your
scanned bots.

11 • Nome del Bot: In the Bots tab, click a bot name to view the action required
message of a specific bot, click the bot name.

• Master Task Reference: In the Processes tab, to view the action required

message of a specific process, click the expand icon ( ), and then click a
task reference name.

Click the message code to view the manual steps you must perform to run the
migrated process successfully in Automation 360.
Puoi anche visualizzare i comandi che il bot contiene e la frequenza o il numero di
volte in cui il comando viene usato nel bot.

Note:  Ogni messaggio include la causa e l'azione da eseguire dopo la migrazione.
Per un elenco di questi messaggi, consulta Messaggi Azione richiesta on page 1302.
Use the message code (for example A101) to view a specific message quickly.

12 Provides the location of the bot.

13 Provides the status of the bot or process.

14 • For bots, this field displays the number of lines used in a bot. This information
will help you understand the complexity of the bot.

• For processes, this field displays the sum of the total number of lines used
in the parent and child bots within a process. This information will help you
understand the complexity of the process.

15 For processes, this field displays the number of bots in a process that requires

action after migration to Automation 360.. Click the expand icon ( ) and then
click a task reference name that is flagged as Action Required.
Click the message code to view the information about changes in Automation
360 behavior for the command compared with the Enterprise 11 or Enterprise 10
behavior.

Note:  This field is available only for processes.
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Campo/
Opzione

Descrizione

16 For processes, this field displays the number of bots in a process that requires

review after migration to Automation 360. Click the expand icon ( ) and then
click a task reference name that is flagged as Review Required.
Click the message code to view the information about changes in Automation
360 behavior for the command compared with the Enterprise 11 or Enterprise 10
behavior.

Note:  This field is available only for processes.

17 Download (as a CSV file) the list of bots, processes, or commands that can or
cannot be migrated so that you can share the file with others.

18 • For bots, this field displays the number of times a bot is used as a child bot.
• For processes, this field displays the sum of the total number of dependencies

used in the parent and child bots within a process.

Il report sarà valido fino a quando non sarà disponibile la successiva versione di Bot Scanner. Quando la
prossima versione di Bot Scanner sarà disponibile, verrà visualizzato un messaggio di scadenza del report.
Sarà necessario scaricare la versione più recente di Bot Scanner ed eseguire nuovamente la scansione dei
bots.

Verifiche e azioni richieste dopo la migrazione

Alcuni comandi nei bots potrebbero essere contrassegnati con Revisione richiesta nel report dei Bot
Scanner. Per questi elementi, è necessario eseguire una determinata convalida o aggiornare i bots dopo la
migrazione.
I seguenti messaggi Bot Scanner richiedono una verifica o alcune azioni:
• Il percorso del bot figlio è completamente variabilizzato e viene risolto

durante il runtime. Il bot non riesce dopo l'esecuzione se il percorso
specificato nella variabile non è valido. Esaminare il bot di migrazione.

Verifica che il bot figlio sia disponibile nella posizione specificata nel percorso variabilizzato. Se il
percorso nel bot padre non è corretto, aggiornare il percorso per indirizzarlo al bot figlio corretto.

• Il valore restituito dalla variabile di sistema "Descrizione errore"
potrebbe essere diverso dalle versioni legacy w.r.t. Esamina il bot migrato.

La descrizione di alcuni messaggi di errore in Automation 360 potrebbe essere diversa da Enterprise 11
o Enterprise 10 per lo stesso errore. Se un bot Enterprise 11 o Enterprise 10 è configurato per prendere
decisioni in base alla descrizione dei messaggi di errore, potrebbe essere necessario aggiornare il bot
migrato in base alla nuova descrizione dei messaggi di errore.

• La migrazione del comando "Database - Connetti" è stata completata, ma è
necessaria una configurazione aggiuntiva per l'autenticazione di Windows.Fai
riferimento alla documentazione relativa al pacchetto database per maggiori
dettagli.

Completa la procedura specificata per connetterti a Microsoft SQL Server con l'autenticazione Windows.
Consulta Connessione a un Microsoft SQL Server con l'autenticazione Windows on page 1456.

• La migrazione di "IF" con condizione variabile è stata completata.
Tuttavia, non è stato possibile determinare il formato della data della
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variabile utente, quindi è stata eseguita la migrazione con il formato
data predefinito mm/dd/yyyy HH:mm:ss. Rivedi e modifica il formato, se
necessario.

Aggiorna il formato della data nel bot migrato allo stesso formato utilizzato in Enterprise 11 per tale bot.
• Impossibile determinare se una variabile utilizzata come posizione è un

indice o un nome di colonna. La posizione dell'indice inizia da 0 invece di
1, quindi eseguire le azioni necessarie, se necessario.

Se sono state utilizzate le variabili di sistema FileData Column[$variable$] o Excel Column[$variable$] in
Enterprise 11 o Enterprise 10 bot, si presuppone che sia stato utilizzato il nome della colonna $variable
$. In questi casi, il bot migrato contiene l'espressione FileData Column{$variable$}. Se $variable$ nel
bot Enterprise 11 o Enterprise 10 contiene il numero della colonna, devi aggiornare l'espressione nel bot
migrato a FileDataColumn[$var.String:toNumber()$].

• Il comando Esegui logica che utilizza le variabili delle credenziali come
input per una logica di un MetaBot

Bots che utilizzano il comando Esegui logica che trasferisce gli attributi Credential Vault da un TaskBot
a una logica MetaBot possono essere migrati a Automation 360. Il nome delle credenziali e il nome
dell'attributo vengono visualizzati nei campi della riga corrispondente del bot migrato.
Se è stata eseguita la migrazione utilizzando il database Enterprise 11 ripristinato, viene creato un
locker equivalente in Automation 360 per le variabili delle credenziali utilizzate nel bot Enterprise 11.
Scegli una delle opzioni seguenti per eseguire correttamente i bots migrati:
• Opzione 1: Trasferisci le variabili di tipo credenziale.

1. Crea una variabile di tipo di credenziale nei bots figli come variabili di input.
2. Nell'action Esegui del package Task Bot del bot padre, aggiorna i campi del valore di input per

utilizzare gli attributi Credential Vault per la variabile di tipo di credenziale creata per il bot figlio
(corrispondente alla logica di MetaBot).

• Opzione 2: Trasferisci i valori delle credenziali come valore globale.
1. Crea il valore globale in Automation 360 per l'uso delle credenziali nel comando Esegui logica

in Enterprise 11.
2. Nell'action Esegui del package Task Bot del bot padre, aggiorna i campi del valore di input

per utilizzare i valori globali per la variabile di tipo di credenziale creata per il bot figlio
(corrispondente alla logica MetaBot).

Se non è stato utilizzato il database Enterprise 11 ripristinato durante l'installazione di Automation
360, crea l'armadietto richiesto per le variabili delle credenziali utilizzate nel bot Enterprise 11 prima di
eseguire i passaggi precedenti.

Note:  Automation 360 fornisce una protezione avanzata consentendo di assegnare gli attributi
Credential Vault solo alle variabili del tipo di credenziale. Ciò limita la gestione non protetta degli
attributi Credential Vault che potrebbero essere stati assegnati a variabili di tipo non credenziale.

Rapporto per un singolo bot

Il report per ciascun bot fornisce informazioni sulle dipendenze, le variabili e i comandi utilizzati.
Il report individuale di un bot è simile al seguente codice:
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            <analysis version="1.3.0">
                <stat>
                    <dependencies ucount="0" count="0"/>
                    <errors ucount="6" count="12">
                        <error count="1">System variable $AAApplicationPath
$</error>
                        <error count="1">Command [If FolderNotExist] 
                        is not supported</error>
                        <error count="3">System variable $CurrentDirectory
$</error>
                        <error count="3">System variable $Extension$</error>
                    </errors>
                </stat>
                <commands>
                    <command target-action="assign" name="VariableOperation"
 line="1" 
                    grp="VariableOperation" api="VarOpe">
                        <msg type="error" review="true"
 category="variable">System 
                        variable $AAApplicationPath$</msg>
                        <msg type="info" review="false"
 category="default">Command 
                        parameter [Option] of type [String] is not
 required.</msg>
                    </command>
                    <command target-action="createFolder"
 name="createFolder" line="3" 
                    grp="FilesFolders" api="CreateFolder"/>
                    <command target-action="copyFiles" name="CopyFiles"
 line="5" 
                    grp="FilesFolders" api="CreateFolder"/>
                    <command target-action="connect" name="Connect"
 line="3" 
                    grp="Database" api="Connect"/>
                    <command target-action="OpenCSVTXT" name="ReadFrom"
 line="9" 
                    grp="CsvText" api="Csv"
                        <msg tpye="info" review="false"
 category="command">Line 
                        in 11.x client, there is no separate option given
 for CSV 
                        and TEXT in Automation 360</msg>
                            <msg type="error" review="true"
 category="variable">System 
                            variable $CurrentDirectory$</msg>
                            <msg type="error" review="true"
 category="variable">System 
                            variable $Extension$</msg>
                            <msg type="error" review="true"
 category="variable">System 
                            variable $FileName$</msg>
                        </command>
                    </commands>
                    <variables>
                        <variable name="$CSV-TXT-Default-DATA$" 
                        type="TABLE" value-type=""/>
                    </varaibles>
                </analysis>
            

La tabella seguente descrive i vari attributi disponibili nel report XML mostrato nell'immagine precedente:
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Nodo Attributo Descrizione

Stat -- Fornisce informazioni sul numero di dipendenze, errori e avvisi.

-- dipendenze Specifica il numero di dipendenze per il bot. The ucount indicates the
number of unique dependencies and the count indicates the total number
of dependencies.

-- errore Specifica il numero di errori per il bot. The ucount indicates the number
of unique errors and the count indicates the total number of errors.

Comando -- Fornisce informazioni sui vari comandi e azioni utilizzati nel bot.

-- command
target-
action

Specifica l’azione eseguita per il comando.

-- nome Specifica il nome del comando.

-- line Specifica il numero di riga in cui il comando è disponibile nel bot.

-- grp Specifica il gruppo di comandi a cui appartiene il comando.

-- api Specifica il nome dell’API utilizzato dal comando.

-- msg type Fornisce informazioni sul tipo di messaggio. The error type indicates that
the command cannot be migrated to Automation 360, and an info type
indicates that the command can be migrated but some of its attributes will
be changed during migration.

-- esaminare Fornisce informazioni sull'eventuale necessità di esaminare il comando.
This attribute is always true for error type messages, which indicates
that migration of that command to Automation 360 is not yet supported.
For info type messages, if the attribute is true, you must review the
value in the category attribute. You can decide whether you want to
take any action on the migrated bot based on the value available in the
category attribute.

-- Categoria Fornisce informazioni sul comando o sulla variabile per cui viene
visualizzato il messaggio.

Variabili Fornisce informazioni sulle variabili di sistema utilizzate dal bot.

-- Nome
variabile

Specifica il nome della variabile.

-- tipo Specifica il tipo di variabile.

-- Tipo valore Specifica il tipo di valore fornito per tale variabile.

See the following video on how to analyze the scanner report

Ottenere la licenza di migrazione
La migrazione è offerta gratuitamente. Per eseguire la migrazione a un ambiente Automation 360 (Cloud o
On-Premises) devi richiedere una licenza di migrazione.
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Termini e durata della licenza

• Se il completamento della migrazione richiede più tempo del previsto, contatta il responsabile del
successo clienti o il rappresentante dell'account per discutere delle estensioni.

• La licenza di migrazione Automation 360 è transitoria, il che significa che si sovrapporrà alla licenza
Enterprise 10 o Enterprise 11 durante il periodo di migrazione.
Una volta completata la migrazione, i prodotti e le licenze Automation 360 verranno trasferite agli
equivalenti 1 a 1 del contratto corrente. Devi rivedere i requisiti di automazione o le date di rinnovo e
determinare se sono necessari aggiornamenti delle licenze.

Note:  Esegui Bot Scanner e determina quando eseguire prima la migrazione. Consigliamo di richiedere
una licenza di migrazione solo dopo aver eseguito Bot Scanner e aver esaminato i prerequisiti per la scelta
di distribuzione.

Richiesta della licenza di migrazione

Quando sei pronto a iniziare la migrazione, contatta il rappresentante dell'account, invia il report Bot
Scanner e specifica se desideri richiedere licenze per una distribuzione Automation 360 Cloud o On-
Premises.
• Per iniziare a utilizzare Automation 360 (Cloud o On-Premises) devi accettare i termini utente del

prodotto.
• Poiché Automation Anywhere ospiterà i dati dei clienti, anche i clienti che effettuano la migrazione a

Automation 360 Cloud devono accettare il Contratto di automazione Cloud.

Per la migrazione Cloud, tieni a mente quanto segue:
• You must request the equivalent number of licenses for Control Room and other entitlements such as

Bot Creators, Bot Runners, IQ Bot, and Bot Insight.
La migrazione non viene eseguita correttamente se il numero di licenze Automation 360 non è
equivalente al numero di Control Room e delle altre autorizzazioni disponibili nell'ambiente Enterprise
11.
Ensure that the number of Automation 360 licenses is equal to the number of Control Room and other
entitlements available in your environment.
In caso contrario, gli account utente non migrati richiederanno ulteriori azioni dopo la migrazione.

• Devi richiedere la licenza prima di iniziare la migrazione, poiché il codice di migrazione è valido per 30
giorni.
Se non disponi di ogni elemento necessario per iniziare la migrazione e ricevi la licenza di migrazione
(insieme al codice di migrazione), i 30 giorni di validità del codice potrebbero scadere nel momento in
cui avvi la migrazione, oppure potresti non avere abbastanza tempo per completare la migrazione.

Attivazione della licenza

• Automation 360 Cloud: Ti verrà fornito un codice di migrazione che include la licenza di migrazione.
Incolla il codice nell'utilità di migrazione Cloud, quindi esegui l'utilità per attivare la licenza.

• Automation 360 On-Premises: Al termine dell'installazione di Automation 360, carica il GUID
quando apri la Control Room di Automation 360. Se non disponi di un GUID di licenza, carica il file della
licenza attuale.
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Preparazione della nuova Control Room per la migrazione
Esegui le attività in questo flusso di lavoro per preparare l'ambiente Automation 360 alla migrazione.
Assicurati di aver completato tutte le attività per verificare la disponibilità alla migrazione: Controlla la
preparazione alla migrazione on page 1135.

1. Choose a deployment model (Cloud, Cloud-enabled, or On-Premises).
2. Richiedi e attiva la licenza di migrazione.
3. In base al modello di distribuzione selezionato, preparare l'ambiente alla migrazione:

Modello di distribuzione Azioni

Cloud • Esegui la migrazione utilizzando l'utilità di
migrazione al cloud: Preparazione per la
migrazione Enterprise 11 a Automation 360 Cloud
on page 1177

• Use both Automation 360 Cloud and
Enterprise 11 in parallel: Preparazione per la
migrazione quando si utilizzano Enterprise 11 e
Automation 360 Cloud in parallelo on page 1185

• Esegui la migrazione manuale a Cloud:
Preparare la migrazione manuale a Automation
360 Cloud on page 1186

Abilitato al cloud Preparazione per abilitare la migrazione da
Enterprise 11 a Automation 360 on page 1201

On-Premises • Enterprise 11 a Automation 360:
• Preparazione per la migrazione Enterprise 11

a Automation 360 On-Premises on page 1189
• Use both Automation 360 On-Premises and

Enterprise 11 in parallel: Preparazione per la
migrazione quando si utilizzano Enterprise 11
e Automation 360 On-Premises in parallelo on
page 1198

• Enterprise 10 a Automation 360:
• Preparazione per la migrazione Enterprise 10

a Automation 360 On-Premises on page 1203
• Utilizza Automation 360 On-Premises e

Enterprise 10 in parallelo:Preparazione per
la migrazione quando si utilizzano Enterprise
10 e Automation 360 On-Premises in parallelo
on page 1209

4. Completa le attività di pre-migrazione.
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Migrazione e la convalida dei bots on page 1212

Scegli modello di implementazione
La piattaforma Automation 360 è stata sviluppata su un'architettura nativa per il cloud con un'unica base
di codici che supporta le distribuzioni Cloud e On-Premises. L'esperienza di tutti i componenti è la stessa,
sia che la piattaforma sia distribuita su Cloud o On-Premises sulla tua infrastruttura, il che può comportare
server fisici, Cloud privato o Cloud pubblico.

Note:  La migrazione è disponibile in Automation 360 a partire dalla Build 2079 per On-Premises e dalla
Build 7554 per le distribuzioni Cloud.

Modelli di distribuzione
Automation 360 fornisce i seguenti modelli di distribuzione:

Cloud Automation 360 Cloud è un'offerta SaaS ospitata
da Automation Anywhere che fornisce un modello
di consumo semplice della piattaforma Automation
360 realizzato su un'architettura nativa per il cloud.
Con il servizio Automation 360 Cloud, la piattaforma
Automation 360, che comprende la Control Room
Automation 360 e le applicazioni (RPA Workspace,
IQ Bot, Bot Insight, AARI e Discovery Bot), è
ospitata da Automation Anywhere e accessibile
agli utenti attraverso un browser Web. I dispositivi
Bot Agent sui quali vengono eseguiti i bots e le
automazioni rimangono sull'infrastruttura del cliente
e si collegano in modo sicuro al servizio Automation
360 Cloud tramite HTTPS.

Abilitato al cloud In questo modello di distribuzione, i dati sono
ospitati On-Premises. Questo modello è adatto
ai clienti che devono attenersi a rigorose norme
regolamentari in cui la sovranità dei dati è
obbligatoria.

On-Premises with packages updates through
Cloud

With Automation Anywhere On-Premises with
packages updates through Cloud service, all
business, personal, and operational data is kept on
and deployed from the server on-premises on the
customer network.

L'immagine seguente mostra i modelli di distribuzione per Automation 360:
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Vedi anche Responsabilità operative Cloud on page 26.

Important:
• Indipendentemente dal modello di distribuzione scelto, si consiglia di configurare la prima istanza di

Automation 360 come ambiente di sviluppo (Dev).
• Si consiglia di disporre di tre ambienti separati per Bot Lifecycle Management: sviluppo (Dev), test (Test

o UAT) e produzione (Prod).
• La configurazione di un ambiente di sviluppo durante il processo di migrazione offre due vantaggi:

• Una piattaforma per testare i bots Enterprise 11 o Enterprise 10 migrati per assicurarsi che vengano
eseguiti correttamente e che forniscano i risultati previsti.

• Accesso per gli sviluppatori al nuovo ambiente Automation 360 per creare una nuova automazione
simultaneamente quando i bots migrati vengono testati.
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Preparazione a Cloud

Quando scegli una distribuzione Automation Anywhere Cloud, non c'è un'infrastruttura server fisica
aggiuntiva da configurare per Control Room. Dopo aver completato l'aggiornamento, puoi usufruire
degli aggiornamenti automatici in tutta l'organizzazione e scalare facilmente nel Cloud. Quando inizi a
utilizzare Automation 360 su Automation Anywhere Cloud, verifica i requisiti di sistema e di compatibilità
per l'esecuzione di Automation 360:
• Requisiti di compatibilitàBot Agent: Bot Agent deve essere installato su dispositivi registrati in modo che

gli utenti possano creare ed eseguire bot su di essi.

Preparazione a Automation 360 abilitato al cloud

Quando scegli la distribuzione abilitata al cloud, sono necessarie due istanze di Control Room: una
distribuita su Automation Anywhere Cloud e un'altra installata sulla tua infrastruttura. The Control Room
deployed on Cloud manages the operational services and the Control Room installed on your infrastructure
manages your business and operational data.
• Requisiti di compatibilitàBot Agent: Bot Agent deve essere installato su dispositivi registrati in modo che

gli utenti possano creare ed eseguire bots su di essi.
• Requisiti di sistema: Requisiti hardware e data center, inclusi server, database, porte, protocolli e altro

ancora.

Preparazione a On-Premises (infrastruttura del cliente)

Installa e gestisci Automation 360 sulla tua infrastruttura. After you have completed your upgrade, you will
benefit from regular updates for packages with new release builds made available to download and install.
Assicurati di soddisfare i requisiti di sistema e di configurazione per Automation 360 On-Premises:
• Requisiti di compatibilitàBot Agent: Bot Agent deve essere installato su dispositivi registrati in modo che

gli utenti possano creare ed eseguire bots su di essi.
• Requisiti di sistema: Requisiti hardware e data center, inclusi server, database, porte, protocolli e altro

ancora.

Preparazione per la migrazione Enterprise 11 a Automation 360
Cloud
Esegui le attività in questo flusso di lavoro per effettuare la migrazione da Enterprise 11 a Automation 360
Cloud, inclusa la migrazione di bots.
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Workflow map: You can also view this migration workflow in an interactive visual format by clicking the

following schematic image:
1. Migrating from Enterprise 11 to Automation 360 Cloud

1. Assicurati di aver completato le attività seguenti per verificare la disponibilità alla migrazione
Controlla la preparazione alla migrazione on page 1135

2. Assicurati di disporre e aver attivato la licenza di migrazione.
Ottenere la licenza di migrazione on page 1172

Per informazioni sulla gestione e sull'elaborazione di licenze e servizi Cloud, consulta Gestione e assegnazione
delle licenze (partner).

Important:
• We support migration only to an Automation 360 Control Room that is hosted on Amazon Web Services

(AWS).
• La migrazione viene eseguita ad una nuova Cloud Control Room, che verrà sottoposta a provisioning

durante la migrazione. Non è possibile riutilizzare una Cloud Control Room esistente per la migrazione.
• I dati del dashboard di log e Bot Insight sono esclusi dal caricamento sulla nuova Cloud Control Room.
• È supportata la migrazione dei dati dalle distribuzioni standard di database Microsoft SQL. Consulta

Versioni Control Room supportate per la migrazione on page 1136.
• Se Enterprise 11 è configurato per l'utilizzo di Active Directory o Single Sign-On (SSO), il tipo di

autenticazione per tutti gli utenti migrati in Automation 360 Cloud viene modificato nel database. La
password di tutti gli utenti migrati è impostata su null, ad eccezione dell'amministratore principale.
Le credenziali di accesso dell'amministratore principale vengono condivise tramite e-mail.
L'amministratore principale può modificare il tipo di autenticazione per gli utenti in SSO prima di
eseguire la migrazione dei bots.

• Azione consigliata: Crea un backup dei dati non migrati in Automation 360 Cloud, ad esempio log di
audit e log di sistema, prima di disattivare le istanze Enterprise 11.

Per la migrazione IQ Bot, consulta Migrazione da Automation 360 IQ Bot On-Premises a Cloud on page 1346.
1. Assicurati che tutte le variabili delle credenziali utilizzate nei bots Enterprise 11 siano disponibili nella

Control Room Enterprise 11.
2. Scarica e installa l'utilità di migrazione Cloud.

Installazione dell'utilità di migrazione Cloud on page 1181
3. Utilizza l'utilità per caricare i dati Enterprise 11 in Automation Anywhere Cloud.

Caricamento dei dati di Enterprise 11 utilizzando l'utilità di migrazione Cloud on page 1183
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Attività di prerequisito per la migrazione bots on page 1211

Flusso di lavoro consigliato per la migrazione Cloud
Esamina il processo di migrazione dei dati Enterprise 11 a Automation 360 Cloud, in particolare se gestisci
ambienti di sviluppo, test e produzione separati.

Important:  Questo è il flusso di lavoro consigliato per la migrazione da Enterprise 11 a Automation 360
Cloud.

In alcuni scenari, potrebbero esserci ambienti Enterprise 11 separati per lo sviluppo (Dev), i test (UAT) e
la produzione (Prod) in base ai requisiti e ciascuno di questi ambienti potrebbe avere più istanze Control
Room. Il numero di licenze Cloud Control Room richieste deve essere uguale al numero totale di istanze
Control Room in tutti gli ambienti Enterprise 11. Ad esempio, se disponi di ambienti separati per Dev,
UAT e Prod e ciascuno di questi ambienti ha due istanze Control Room, dovrai richiedere sei licenze Cloud
Control Room.
Quando esegui la migrazione da Enterprise 11 a Automation 360 Cloud, devi copiare tutti i bots dagli
ambienti di produzione e test nell'ambiente di sviluppo utilizzando Bot Lifecycle Management. In questo
modo, prima di avviare il processo di migrazione, tutti i bots nuovi o modificati disponibili negli ambienti di
produzione e di test sono disponibili nell'ambiente di sviluppo.
L'immagine seguente mostra il flusso di lavoro di migrazione da Enterprise 11 a Automation 360 Cloud:
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1. Facoltativo: Copia i bots dall'ambiente Prod all'ambiente Dev Enterprise 11 utilizzando Bot Lifecycle
Management.
Bot Lifecycle Management - an overview

2. Facoltativo: Copia i bots dall'ambiente UAT all'ambiente Dev Enterprise 11 utilizzando Bot Lifecycle
Management.
Bot Lifecycle Management - an overview

3. Analizza i bots e identifica i comandi e le variabili utilizzati nei bots che sono supportati per la
migrazione in Automation 360.
Scan Enterprise 11 or 10 bots using Bot Scanner on page 1160 | Analisi del report di Bot Scanner per la
migrazione on page 1162
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4. Carica i dati di Enterprise 11 su Cloud Control Room Dev utilizzando l'utilità di migrazione Cloud.
Installazione dell'utilità di migrazione Cloud on page 1181 | Caricamento dei dati di Enterprise 11
utilizzando l'utilità di migrazione Cloud on page 1183

5. Carica i dati di Enterprise 11 su Cloud Control Room UAT utilizzando l'utilità di migrazione Cloud.
6. Carica i dati di Enterprise 11 su Cloud Control Room Prod utilizzando l'utilità di migrazione Cloud.
7. Completa la seguente procedura nell'ambiente Dev Automation 360 Cloud:

a. Converti i bots (TaskBots e MetaBots) in formato .atmx e .mbot al formato .bot Automation
360 utilizzando Bot Migration Wizard.

b. Copia i bots convertiti nell'ambiente UAT Automation 360 Cloud utilizzando Bot Lifecycle
Management.
Bot Lifecycle Management on page 2832

c. Testa i bots convertiti nell'ambiente UAT Automation 360 Cloud.
Se i bots migrati non funzionano come previsto e richiedono alcune modifiche, sposta i bots
nell'ambiente Dev Automation 360 Cloud.
Dopo aver modificato i bots, spostali nell'ambiente UAT Automation 360 Cloud per il test. Ripeti
questo processo fino a quando tutti i bots migrati non funzionano come previsto.

d. Dopo che tutti i bots convertiti sono stati testati e funzionano come previsto, copia i bots
nell'ambiente Prod Automation 360 Cloud.

Installazione dell'utilità di migrazione Cloud
L'utilità di migrazione Cloud consente di caricare tutti i dati Enterprise 11 su Automation Anywhere Cloud.
Dopo aver caricato correttamente i dati su Cloud, viene creata la Control Room Cloud e tutti i dati caricati
sono disponibili per l'uso nella Control Room.
L'utilità esegue la migrazione dei dati dall'archivio Control Room (bots, relative dipendenze e Credential
Vault) e dal database Control Room (utenti, ruoli, pianificazioni, code e impostazioni Control Room).

Note:  La migrazione di dati di Control Room Enterprise 11, come utenti, ruoli e credenziali, in Automation
360 Cloud su Google Cloud Platform non è supportata.

Prendi in considerazione i consigli seguenti:
• Ensure that you install the Cloud Migration Utility on the same application server where the Enterprise

11 Control Room is installed. Per Enterprise 11, assicurati anche che l'utilità sia installata sullo stesso
database dove è ospitato il database Bot Insight.

• Se Enterprise 11 è stato installato in modalità cluster, installa l'utilità di migrazione su uno dei nodi del
cluster.

1. Scarica l'ultima versione dell'utilità di migrazione Cloud dal sito di supporto Automation Anywhere: A-
People Downloads page (Login required).
a) Nella sezione Automation Anywhere Automation 360, fai clic sul link Utilità di migrazione cloud

Automation Anywhere Enterprise.
b) Scarica il file .zip.

2. Estrai il file .zip ed esegui il file AAE Cloud Migration Utility.exe come amministratore.
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3. Nella schermata Requisito, fai clic su Installa.
La schermata elenca le applicazioni necessarie per installare l'utilità sul computer. L'utility installa le
applicazioni richieste; non è necessaria alcuna installazione separata.

4. Nella schermata di Benvenuto, fai clic su Avanti.
5. Nella schermata Contratto di licenza, leggi e accetta la licenza, quindi fai clic su Avanti.
6. Nella schermata Cartella di destinazione, fai clic su Cambia se desideri modificare la posizione in

cui installare l'utilità e fai clic su Avanti.
7. Nella schermata Pronto per installare il programma fai clic su Installa.

La schermata Installazione dell'Utilità di migrazione al cloud AAE visualizza l'avanzamento
dell'installazione.

8. Nella schermata Completato, fai clic su Fine.

Per Enterprise 11, Caricamento dei dati di Enterprise 11 utilizzando l'utilità di migrazione Cloud on page 1183

Prerequisiti per la migrazione al Cloud
Dopo aver installato l'utilità di migrazione al Cloud, è necessario eseguire alcune operazioni prima di
iniziare a caricare i dati su Automation 360.
Completa i seguenti requisiti prima di eseguire l'utilità di migrazione al Cloud per caricare i dati su
Automation 360 Cloud:
• Utilità di migrazione al cloud

• Installazione dell'utilità di migrazione al cloud
• Puoi eseguire la migrazione solo una Control Room alla volta. Quando ti connetti alla Control

Room, assicurati che il percorso di installazione, il percorso dell'archivio e i dettagli del database
appartengano alla stessa Control Room prima di eseguire l'utilità di migrazione Cloud.

• Codice di migrazione: Assicurati di aver ricevuto un'e-mail contenente un codice di migrazione.
Contatta il rappresentante di vendita per ricevere il codice.
Il codice di migrazione è valido solo per una Control Room . Se disponi di più istanze di Control Room,
riceverai un numero equivalente di codici di migrazione. Assicurati di utilizzare il codice di migrazione
corretto per la migrazione di una specifica Control Room.

Important:  Il codice di migrazione ricevuto tramite e-mail è valido per 30 giorni dalla data in cui
viene generato e condiviso con te. Quindi, avvia la migrazione prima della scadenza del codice. In caso
contrario, dovrai richiedere un nuovo codice, e ciò potrebbe richiedere molto tempo.

• Tenant cliente cloud Automation Anywhere:
• The tenant name does not support the underscore ( _ ) character. So an underscore is used in the

tenant name, the specified URL will not be created.

© 2023 Automation Anywhere. All rights reserved.     1182



    Automation Anywhere - Migrazione a Automation 360

• Porta, firewall, connessione a Internet
• La porta utilizzata per connetterti al database della Control Room Enterprise 11 deve essere aperta e

disponibile per l'utilità.
• Il firewall deve essere configurato in modo da consentire all'utilità di connettersi a quanto segue per

il traffico HTTPS in uscita sulla porta 443:
• https://aa-provsvc.globalservices.automationanywhere.digital/
• https://aws.amazon.com

• Assicurati che la connessione a Internet sia stabile e che la larghezza di banda sia sufficiente per
caricare i dati entro 60 minuti. Se il tempo di caricamento supera i 60 minuti, l'utilità di migrazione
Cloud si disattiva ed è necessario avviare nuovamente il processo di caricamento.

• Control Room Enterprise 11
• Consigliamo di pianificare un periodo di inattività per la Control Room Enterprise 11 o di

interrompere ogni attività utente quando si utilizza l'utilità di migrazione.
Il tempo di inattività è necessario a garantire che non vengano persi dati quando l'utilità di
migrazione Cloud comprime i dati Enterprise 11 per il caricamento. Se non è possibile programmare
un tempo di inattività, assicurati che non vengano eseguite attività utente su Control Room
Enterprise 11 nel periodo di tempo in cui l'utilità di migrazione Cloud carica i dati.

• Control Room: Assicurati che le dimensioni dell'archivio di Enterprise 11 siano inferiori a 20 GB e
che quelle del database di Enterprise 11 siano inferiori a 9 GB.
Se le dimensioni dell'archivio o del database sono superiori, contatta il supporto Automation
Anywhere per assistenza.

• Assicurati che le credenziali utilizzate per la connessione al database Enterprise 11 dispongano
dell'autorizzazione db_owner.

• Assicurati che l'archivio Enterprise 11 e il database che specifichi nell'utilità di migrazione Cloud
appartengano alla stessa Control Room Enterprise 11.

• File di log: Concedi all'utilità di migrazione l'accesso alla cartella C:\ProgramData
\AutomationAnywhere per memorizzare i file di log.

• Credential Vault: Assicurati che la modalità Credential Vault sia impostata su modalità Express.
• In questo modo garantisci che le credenziali e le variabili disponibili all'interno del Credential Vault di

Enterprise 11 vengano migrate a Cloud Control Room.
• Se Credential Vault è impostato sulla modalità manuale in Enterprise 11, le credenziali e le variabili

nel Credential Vault di Enterprise 11 non verranno migrate a Cloud Control Room.

Dopo la migrazione dei dati di Control Room puoi ripristinare la modalità manuale. Consulta Configure
Credential Vault Connection mode on page 2740.

• SSO: Se desideri integrare SSO dopo la migrazione a Automation 360 Cloud, assicurati che gli ID
degli utenti in Control Room Enterprise 11 corrispondano esattamente agli ID nel database SSO.
L'integrazione SSO non viene eseguita se gli ID non corrispondono.

Related concepts
Ottenere la licenza di migrazione on page 1172
La migrazione è offerta gratuitamente. Per eseguire la migrazione a un ambiente Automation 360 (Cloud o
On-Premises) devi richiedere una licenza di migrazione.

Caricamento dei dati di Enterprise 11 utilizzando l'utilità di migrazione Cloud
Utilizza l'utilità di migrazione Cloud per raccogliere i dati Enterprise 11 e caricarli su Automation Anywhere
Cloud.
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Assicurati di aver completato tutti i prerequisiti prima di iniziare il caricamento dei dati su Automation 360.
Consulta Prerequisiti per la migrazione al Cloud on page 1182.

Note:  Arresta il servizio Automation Anywhere Control Room Reverse Proxy.
Se Enterprise 11 è installato in un'installazione cluster, devi arrestare il servizio Automation Anywhere
Control Room Reverse Proxy su tutti i nodi del cluster.

1. Esegui l'utilità di migrazione Cloud come amministratore.
2. Seleziona l'opzione Connetti a Internet tramite proxy se desideri connetterti a Internet utilizzando

un server proxy, quindi fai clic su Inizia.
a) Specifica il nome host o l'indirizzo IP del server proxy nel campo Nome host/indirizzo IP

proxy.
b) Specifica la porta che desideri utilizzare per connetterti all'host nel campo Porta.
c) Seleziona l'opzione Autenticazione se il server proxy richiede l'autenticazione.
d) Specifica le credenziali che desideri utilizzare per l'autenticazione nei campi Nome utente e

Password.

3. Nella schermata Collegamento alla Control Room, immetti i seguenti dettagli sull'ambiente
Enterprise 11.

Important:  These fields are automatically populated with the required values from the Enterprise
11 environment when the Cloud migration utility is run on the same application server where the
Enterprise 11 Control Room is installed.

Poiché è possibile migrare solo una Control Room alla volta, assicurati che il percorso di installazione, il
percorso dell'archivio e i dettagli del database appartengano alla stessa Control Room.

Campo Valore

Percorso di installazione La posizione in cui è installata la Control Room.
The Installation path value is auto-populated to
ensure that the details match with the Control
Room database.

Note:  Network path is not supported as an
Installation Path value.

Percorso archivio La posizione in cui è memorizzato l’archivio di
Control Room.
The Repository Path value is automatically
populated and cannot be edited. This is to ensure
that the details match those in theControl Room
database.

Indirizzo IP/Nome host L’indirizzo IP o il nome host del server di
database.

Porta La porta utilizzata per connettersi al server di
database.

Nome database Il nome del database Control Room che desideri
caricare.
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Campo Valore

Connessione sicura Opzione per utilizzare una connessione sicura per
connettersi al database.

Autenticazione Authentication method that you want to use:
• Autenticazione Windows: Seleziona

questa opzione per utilizzare l'autenticazione
Windows e stabilire una connessione con il
server di database.

Note:  The user who is logged in to the
Enterprise 11 server and is running the Cloud
migration utility must be a Windows user
administrator with db_owner permission to
the Enterprise 11 database.

• Autenticazione SQL: Seleziona questa
opzione per utilizzare le credenziali del
database per l'autenticazione quando stabilisci
una connessione con il server di database.
Se selezioni questa opzione, devi fornire
le credenziali che desideri utilizzare per
connetterti al server del database nei campi
Nome utente e Password.

Percorso di backup La posizione in cui desideri archiviare il backup
dei dati Enterprise 11 Control Room.

4. Fai clic su Avanti.
5. Nella schermata Riepilogo, rivedi le informazioni inserite e fai clic su Avanti.
6. Nella schermata Convalida codice di migrazione immetti il codice di migrazione ricevuto tramite e-

mail e fai clic su Convalida.
Il sistema convalida il codice di migrazione immesso.

7. Fai clic su Avanti.
Il sistema estrae i dati di Enterprise 11 e ne avvia il trasferimento a Automation Anywhere Cloud.

8. Fai clic su Esci.
Una volta caricati correttamente i dati, riceverai un messaggio e-mail con un collegamento e le
credenziali per accedere a Control Room.

See the following video on how to upload Enterprise 11 data using the Cloud Migration Utility:

See the following video on how to verify the Enterprise 11 data in the Cloud Control Room:

Migrazione dei bots di Enterprise on page 1216

Preparazione per la migrazione quando si utilizzano Enterprise 11 e
Automation 360 Cloud in parallelo
Esegui le attività in questo flusso di lavoro se desideri utilizzare sia Automation 360 Cloud sia Enterprise
11 in parallelo. È possibile continuare a utilizzare entrambi gli ambienti fino a quando non si è pronti ad
avviare la migrazione da Enterprise 11 a Automation 360 Cloud.
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1. Assicurati di aver completato le attività seguenti per verificare la disponibilità alla migrazione
Controlla la preparazione alla migrazione on page 1135.

2. Assicurati di disporre e aver attivato la licenza di migrazione.
Ottenere la licenza di migrazione on page 1172

Important:
• La migrazione viene eseguita ad una nuova Cloud Control Room, che verrà sottoposta a provisioning

durante la migrazione. Non è possibile riutilizzare una Cloud Control Room esistente per la migrazione.
• Non è possibile utilizzare l'utilità di migrazione a Cloud per caricare i dati su Cloud Control Room se sono

stati selezionati SKU standard Automation 360 Cloud al momento della firma del modulo d'ordine.
If you want to use the Cloud Migration Utility, you must have selected the Automation 360 Cloud
migration SKUs when you signed the order form.

1. Assicurati che tutte le variabili delle credenziali utilizzate nei bots Enterprise 11 siano disponibili nella
Control Room Enterprise 11.

2. Scarica e installa l'utilità di migrazione Cloud.
Installazione dell'utilità di migrazione Cloud on page 1181

3. Utilizza l'utilità di migrazione Cloud per caricare i dati Enterprise 11 in Automation Anywhere Cloud.
Caricamento dei dati di Enterprise 11 utilizzando l'utilità di migrazione Cloud on page 1183

4. Continua a utilizzare entrambi gli ambienti Enterprise 11 e Automation 360 in parallelo.

Note:  Crea tutti i nuovi bots e le nuove entità, quali utenti, ruoli e pianificazioni in Automation 360.

5. Se crei una nuova entità come utenti, ruoli o pianificazioni (ad eccezione di bots) in Enterprise 11 dopo
l'installazione di Automation 360, crea la stessa entità in Automation 360.

6. Quando sei pronto a utilizzare solo Automation 360 come ambiente di produzione:
a) Se hai creato nuovi bots in Enterprise 11, i dati vengono caricati in Automation 360 Cloud:

1. Esporta tutti i bots e le relative dipendenze create dopo il caricamento dei dati su Automation
360 Cloud utilizzando Bot Lifecycle Management.
Export bots

2. Importa tutti i bots in Automation 360 utilizzando Bot Lifecycle Management.
Importa bots on page 2837

Note:  After migration, if you add any new Bot Insight data or dashboard or modify any existing
data in Enterprise 11, these changes are currently not imported to Automation 360 and therefore
will not be migrated.

Attività di prerequisito per la migrazione bots on page 1211

Preparare la migrazione manuale a Automation 360 Cloud
Puoi eseguire manualmente la migrazione da Enterprise 11 o Enterprise 10 a Automation 360 Cloud (senza
utilizzare l'utilità di migrazione Cloud) creando utenti, ruoli, autorizzazioni e altre entità necessarie affinché
i bots possano essere eseguiti correttamente.
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Note:  The only way by which you can migrate from Enterprise 11 or Enterprise 10 to Automation 360
Cloud on Google Cloud Platform is by using the following procedure.

1. Assicurati di aver completato le attività seguenti per verificare la disponibilità alla migrazione
Controlla la preparazione alla migrazione on page 1135.

2. Assicurati di disporre e aver attivato la licenza di migrazione.
Ottenere la licenza di migrazione on page 1172

Note:  Adotta la migrazione manuale nei seguenti scenari:
• Disponi di un'istanza esistente di Automation 360 Cloud e vuoi migrare i tuoi dati Enterprise 11.
• Quando desideri eseguire solo la migrazione dei bots e ricreare manualmente tutte le altre entità di

Enterprise 11 o Enterprise 10, ad esempio utenti, ruoli e credenziali, in Automation 360.
• Quando desideri eseguire solo la migrazione di alcune entità Enterprise 11 o Enterprise 10. Ad esempio,

se disponi di 50 utenti e di 10 ruoli definiti dall'utente in Enterprise 11 o Enterprise 10 e desideri
migrare solo 40 utenti e 7 ruoli in Automation 360. Allo stesso modo, se desideri eseguire la migrazione
solo di utenti e ruoli e ricreare le pianificazioni richieste in Automation 360.

Per informazioni sulla migrazione automatica a Cloud (utilizzando l'utilità di migrazione Cloud), consulta
Preparazione per la migrazione Enterprise 11 a Automation 360 Cloud on page 1177.
1. Crea tutte le entità Enterprise 11 o Enterprise 10 in Automation 360 Cloud.

Per ulteriori informazioni sulle entità da creare, consulta Prerequisiti per la migrazione manuale on page
1188.

2. Carica bots:
Versione Fasi

Enterprise 11 Importa bots on page 2837

Enterprise 10 a. Upload bot and its dependencies on page 2046
bots vengono caricati nello spazio di lavoro
privato in Automation 360. Assicurati di aver
creato la stessa struttura di cartelle nello
spazio di lavoro pubblico come in Enterprise
10 Control Room.
È necessario caricare tutti i file dipendenti
bots e gli altri file richiesti da bots caricato
per l'esecuzione in Automation 360. Tutti i
bots caricati, i relativi dipendenti bots e gli
altri file richiesti devono essere archiviati
nella stessa cartella in Automation 360 come
in Enterprise 10.

b. Archivia i bots caricati disponibili nello spazio
di lavoro privato.
Check in a bot on page 1997

See the following video on how to manually migrate to Automation 360 using Bot Lifecycle Management:
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Attività di prerequisito per la migrazione bots on page 1211

Prerequisiti per la migrazione manuale
Quando esegui la migrazione da Enterprise 11 o Enterprise 10, se non hai utilizzato il database Enterprise
11 o copiato i dati Enterprise 10, devi creare manualmente tutte le entità di Enterprise 11 o Enterprise 10
in Automation 360.
Crea le seguenti entità Enterprise 11 o Enterprise 10 tranne i bots in Automation 360:
• Create a user on page 2684
• Create a role on page 2693
• Credenziali e lockers utilizzate nei bots

Credentials and lockers in the Credential Vault on page 2839
• Valore globale AAApplicationPath e imposta il valore uguale a Enterprise 11 o Enterprise 10 per gli

utenti richiesti
• Valore globale AADefaultDateFormat e imposta il valore come MM/GG/AAAA HH:MM:SS.
• I seguenti valori globali verranno utilizzati dall'action Invia e-mail:

• AAE_EmailSettings_auth
• AAE_EmailSettings_host
• AAE_EmailSettings_port
• AAE_EmailSettings_ssl

I valori per i valori globali di cui sopra devono essere uguali a quelli specificati in Enterprise 11 in
Strumenti > Opzioni > Impostazioni e-mail.
Devi creare i valori globali AAE_EmailSettings_auth e AAE_EmailSettings_ssl di tipo boleano. Il valore
di questi valori deve essere assegnato in base alla configurazione Enterprise 11. For example, if
the My server requires authentication option is selected in Enterprise 11, you must set the
AAE_EmailSettings_auth value as true. Similarly, if the My server uses a secure connection option
is selected in Enterprise 11, you must set the AAE_EmailSettings_ssl value as true.

• I seguenti valori globali se hai utilizzato Exchange Web Services (EWS) in Enterprise 11:
• AAE_EmailSettings_tenantId
• AAE_EmailSettings_clientId
• AAE_EmailSettings_domainName

• Create the same folder structure as Enterprise 11 or Enterprise 10 in Automation 360.

Important:  You must create the MetaBots folder in the Bots folder in Automation 360 even if you
do not have any MetaBots in Enterprise 11 or Enterprise 10.

• Carica tutti i bots Enterprise 11 o Enterprise 10 e le relative dipendenze in Automation 360 Control
Room.
Devi caricare i bots e le relative dipendenze nella stessa posizione in Enterprise 11 o Enterprise 10.

• Esegui la migrazione di bots nella sequenza seguente:
1. MetaBots
2. bots figlio
3. bots padre o principali

Important:  Devi creare tutte le entità di cui sopra in Automation 360 nello stesso modo in cui sono
disponibili in Enterprise 11 o Enterprise 10.

© 2023 Automation Anywhere. All rights reserved.     1188



    Automation Anywhere - Migrazione a Automation 360

Preparazione per la migrazione Enterprise 11 a Automation 360
On-Premises
Esegui le attività in questo flusso di lavoro per eseguire la migrazione da Enterprise 11 a Automation 360
On-Premises, inclusa la migrazione di bots a Automation 360. Vengono migrati anche i dashboard creati
Bot Insight in Enterprise 11 per bots l'analisi.
Workflow map: You can also view this migration workflow in an interactive visual format by clicking the

following schematic image:
1. Migrating from Enterprise 11 to Automation 360 On-Premises

1. Assicurati di aver completato le attività seguenti per verificare la disponibilità alla migrazione
Controlla la preparazione alla migrazione on page 1135.

2. Assicurati di disporre e aver attivato la licenza di migrazione.
Ottenere la licenza di migrazione on page 1172

3. Se stai installando Automation 360 su un computer su cui Enterprise 11 era stato installato in
precedenza, è necessario eliminare i dati dalla cartella dati Elasticsearch situata in C:/ProgramData/
elasticsearch/data.
Se la posizione della cartella dati Elasticsearch è stata modificata, è possibile trovare le informazioni
aggiornate nel file C:\Program Files\Automation Anywhere\Enterprise\elasticsearch
\config\elasticsearch.yml.

Important:  Se si eliminano i dati Elasticsearch, i dati di audit di Enterprise 11 andranno persi.

Note:  Installa Automation 360 su un server separato per assicurare che l'ambiente Enterprise 11 non sia
interessato dalle attività di migrazione.

1. È consigliabile creare un backup del database Enterprise 11 e ripristinarlo nella stessa istanza SQL o
in una istanza SQL diversa per evitare errori di qualsiasi attività automatica che utilizza il database
Enterprise 11.
Quickstart: Back up and restore a SQL Server database on-premises

Migrazione Bot Insight: I dati Bot Insight e i dashboard vengono migrati come parte del processo
di migrazione generale. Per la migrazione, clona il database Bot Insight (che è diverso dal database
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Enterprise 11 Control Room), estrai ed esporta i metadati del dashboard in Automation 360 utilizzando
l'utilità di pre-migrazione Bot Insight.
Esportazione di dashboard Enterprise 11 Bot Insight per la migrazione on page 1194
The following video shows how to create a backup of the Enterprise 11 database:

2. Se stai effettuando la migrazione dalla versione 11.3.x o da versioni successive, elimina i dati della
tabella ES_SETTINGS dal database della Control Room Enterprise 11.

3. Copia e incolla l'archivio della Control Room Enterprise 11 e aggiorna il database Enterprise 11 con il
percorso archivio di Automation 360.
Copiare e incollare le informazioni di Enterprise 11 in Automation 360 on page 1191

4. Assicurati che tutte le variabili delle credenziali utilizzate nei bots Enterprise 11 siano disponibili nella
Control Room Enterprise 11.

5. Installazione di Automation 360 On-Premises:
a) Assicurati che i requisiti di sistema siano soddisfatti.

Automation 360 On-Premises prerequisites on page 840
b) Installa Automation 360 On-Premises Control Room in modalità personalizzata in un ambiente di

gestione temporanea.
Installing Control Room using Custom mode on page 902

Important:  Durante l'installazione, configura Automation 360 On-Premises Control Room per
utilizzare il database Enterprise 11 ripristinato. Ciò assicura che tutti i dati Enterprise 11 siano
disponibili in Automation 360 così come sono. Per informazioni sui dati migrati e non migrati,
consulta Quali elementi vengono migrati e quali no on page 1128.

6. Dopo aver installato il Automation 360 On-Premises, aggiornare l'URL di accesso a Automation 360 nel
database della Control Room Enterprise 11 ripristinato.Questo URL di accesso sarà usato per accedere
alla Control Room in Automation 360.
Per aggiornare l'URL di accesso: update CONFIGURATION set value = '[Automation 360 Control
 Room URL]' where category = 'CR_setup_general' and config_key = 'AccessUrl'
Esempio di query: update [Automation 360-Database].[dbo].[CONFIGURATION] set value ='http://
Automation 360-crurl.com' where config_key='AccessUrl'

Note:  Non includere una barra ('/') alla fine dell'URL di accesso fornito nel comando precedente.

7. Verifica che tutti i dati incollati siano disponibili nei file e nelle cartelle pertinenti.
8. Optional: Esegui la migrazione dei log di audit.

Esegui la migrazione dei log di audit Enterprise 11 on page 1196
Per ulteriori informazioni, cerca il corso sulla Migrazione da Enterprise 11 a Automation 360 On-Premises in
Automation Anywhere University: RPA Training and Certification (A-People login required).

Attività di prerequisito per la migrazione bots on page 1211
Related tasks
Preparazione per la migrazione Enterprise 10 a Automation 360 On-Premises on page 1203
Esegui le attività in questo flusso di lavoro per eseguire la migrazione da Enterprise 10 a Automation 360
On-Premises, inclusa la migrazione di bots a Automation 360.

Backup e ripristino del database Enterprise 11 o Enterprise 10
Prima di avviare la migrazione, esegui il backup e ripristina il database Enterprise 11 o Enterprise 10.
Quickstart: Back up and restore a SQL Server database on-premises.
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Copiare e incollare le informazioni di Enterprise 11 in Automation 360
I file dell'archivio del server Enterprise 11 e il file Credential Vault sono richiesti nell'ambiente Automation
360. Il modo più efficiente per ottenere questi dati è copiarli dall'ambiente Enterprise 11 in Automation
360.
Devi copiare i file necessari dai dati Enterprise 11 e incollarli prima di installare Automation 360. È inoltre
necessario eseguire le query per aggiornare l'URL di accesso Control Room e il percorso dell’archivio.
Per ulteriori informazioni sulla migrazione a Automation 360, fai riferimento ai seguenti corsi in Automation
Anywhere University: RPA Training and Certification (A-People login required):
• Migrazione da Enterprise 11 a Automation 360 On-Premises
• Migrazione da Enterprise 10 a Automation 360 On-Premises

1. Copia e incolla i dati dell'archivio Enterprise 11.
La posizione dell'archivio di Enterprise 11 è disponibile in Amministrazione > Impostazioni >
Generale di Enterprise 11 Control Room.
Consulta Configuration settings .

Remember:
• Se il Credential Vault Enterprise 11 è configurato in modalità Manuale, copia il file contenente

la chiave master di Credential Vault, memorizzata in una posizione sicura. La chiave master è
richiesta quando si accede a Automation 360 per la prima volta dopo la migrazione da Enterprise
11 utilizzando il database Enterprise 11.

• Se per Control Room Enterprise 11 è abilitato il controllo delle versioni, le versioni più recenti
di ciascun bot, incluse le dipendenze, vengono copiate e migrate dall'archivio Enterprise 11 in
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Automation 360. Tuttavia, la cronologia delle versioni di bot e delle relative dipendenze non viene
copiata né migrata.

• Se desideri impostare una configurazione cluster in Automation 360, devi incollare i dati Enterprise
11 copiati in un percorso di rete condiviso a cui tutti i nodi possono accedere nel cluster.

• Se stai usando il NAS per memorizzare i dati dell'archivio Enterprise 11 e i dati dell'archivio di
Automation 360 si trovano sul disco locale, il processo di copiatura dei dati Enterprise 11 dal NAS al
disco locale di Automation 360 rimane lo stesso.

a) Crea la seguente struttura di cartelle in qualsiasi posizione del dispositivo, se non esiste già.
Ad esempio, C:\ProgramData\AutomationAnywhere\Server Files

Note:
• Se desideri impostare una configurazione cluster in Automation 360, devi incollare i dati

Enterprise 11 copiati in un percorso di rete condiviso a cui tutti i nodi possono accedere nel
cluster.

• Se il database Enterprise 11 è memorizzato nell'archivio NAS e desideri eseguire la migrazione
sul disco locale di Automation 360, il processo per copiarlo e incollarlo è lo stesso.

b) Create the following folders within the Server Files folder you have created in Step a: Default
\0\Automation Anywhere\Bots

In base alle cartelle create nel passaggio precedente, la struttura finale delle cartelle deve essere:
C:\ProgramData\AutomationAnywhere\Server Files\Default\0\Automation
 Anywhere\Bots

C:\ProgramData\AutomationAnywhere\Server Files nella struttura di cartelle è il
percorso dinamico, che corrispondere a qualsiasi posizione in base alle tue esigenze. Default
\0\Automation Anywhere\Bots è invece un percorso costante che non cambia.

Note:  Questo percorso non è uno temporaneo per la migrazione, ma sarà usato per
memorizzare tutti i bots e packages.

c) Copia e incolla il file Enterprise 11 CredentialVault.dat e le cartelle che contengono bots e
MetaBots nella struttura di cartelle creata nel passaggio precedente.

File e cartelle Enterprise
11 da copiare

Posizione Enterprise 11 Posizione Automation
360

File
CredentialVault.dat

AutomationAnywhere
\Server Files

Il file
CredentialVault.dat
è disponibile in questa
posizione solo se
Credential Vault Enterprise
11 è configurato in
modalità Express.

AutomationAnywhere
\Server Files
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File e cartelle Enterprise
11 da copiare

Posizione Enterprise 11 Posizione Automation
360

Tutti i file e le cartelle,
comprese le cartelle Le
 mie attività e I
 miei MetaBot

\AutomationAnywhere
\Server Files
\Default\Automation
 Anywhere\

\AutomationAnywhere
\Server Files
\Default
\0\Automation
 Anywhere\Bots\

a) Crea una cartella per Automation 360 in una qualsiasi posizione sul dispositivo.
Ad esempio, D:\New project\Automation 360.

Notes:
• Se desideri impostare una configurazione cluster in Automation 360, devi incollare i dati

Enterprise 11 copiati in un percorso di rete condiviso a cui tutti i nodi possono accedere nel
cluster.

• Se il database Enterprise 11 è memorizzato nell'archivio NAS e desideri eseguire la migrazione
sul disco locale di Automation 360, il processo per copiarlo e incollarlo è lo stesso.

b) Crea le seguenti cartelle all'interno della cartella Automation 360 creata nel passaggio precedente:
AutomationAnywhere\Server Files\Default\0\Automation Anywhere\Bots

In base alle cartelle create nel passaggio precedente, la struttura finale delle cartelle deve essere:
D:\New project\Automation 360\AutomationAnywhere\Server Files\Default
\0\Automation Anywhere\Bots

D:\New project\Automation 360 nella struttura di cartelle è il percorso dinamico, che può
essere qualsiasi posizione in base alle tue esigenze. Mentre AutomationAnywhere\Server
 Files\Default\0\Automation Anywhere\Bots è un percorso costante che non cambia.

c) Copia e incolla il file Enterprise 11 CredentialVault.dat e le cartelle che contengono bots e
MetaBots nella struttura di cartelle creata nel passaggio precedente.

File e cartelle Enterprise
11 da copiare

Posizione Enterprise 11 Posizione Automation
360

File
CredentialVault.dat

AutomationAnywhere
\Server Files

Il file
CredentialVault.dat
è disponibile in questa
posizione solo se
Credential Vault Enterprise
11 è configurato in
modalità Express.

AutomationAnywhere
\Server Files
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File e cartelle Enterprise
11 da copiare

Posizione Enterprise 11 Posizione Automation
360

Tutti i file e le cartelle,
comprese le cartelle Le
 mie attività e I
 miei MetaBot

\AutomationAnywhere
\Server Files
\Default\Automation
 Anywhere\

\AutomationAnywhere
\Server Files
\Default
\0\Automation
 Anywhere\Bots\

See the following video on how to create the Enterprise 11 Control Room repository in the
Automation 360 server:

You must perform the following step (Step 2) on the Enterprise 11 restored database that you backed up
as part of Step 1 in Prepare for migration.
2. Aggiornare il percorso dell'archivio di Automation 360 nel database Enterprise 11 ripristinato tramite il

seguente comando SQL:
Per aggiornare il percorso dell'archivio, aggiorna il valore CONFIGURATION set = percorso
 dinamico Automation 360 Control Room seguito da \AutomationAnywhere\Server
 Files con categoria = 'CR_setup_general' e config_key = 'RepositoryPath'
Il percorso dinamico nella query è il percorso dinamico in cui sono stati incollati i dati Enterprise 11
copiati nella fase precedente.
Esempio di query: update [Automation 360-Database].[dbo].[CONFIGURATION] set value ='C:
\ProgramData\AutomationAnywhere\Server Files' where config_key='RepositoryPath'
Il percorso menzionato nella query è uguale al percorso dinamico in cui i dati Enterprise 11 vengono
copiati nell'esempio nella fase precedente.
See the following video on how to restore a backed-up Enterprise 11 database:

Completa i passaggi elencati in Preparazione per la migrazione Enterprise 11 a Automation 360 On-Premises on
page 1189.

Esportazione di dashboard Enterprise 11 Bot Insight per la migrazione
Utilizza l'utilità di pre-migrazione Bot Insight per esportare i metadati del dashboard Enterprise 11 Bot
Insight (widget e layout) e il profilo del dashboard come file zip. Esegui questa utilità nel dispositivo
Enterprise 11 e incolla il file zip nell'archivio Automation 360 per migrare i dashboard Bot Insight.
• Esegui il backup del database Bot Insight dopo aver eseguito il backup del database Enterprise 11

Control Room e ripristinalo nell'istanza SQL Server. Quando ripristini il database Bot Insight:
• Usa lo stesso nome utente e la stessa password del database Control Room utilizzato in Automation

360.
• Il nome del database Bot Insight che ripristini nell'ambiente Automation 360 è lo stesso del database

di cui si è eseguito il backup del Bot Insight Enterprise 11.

• Assicurati che il JRE sia installato nel dispositivo Enterprise 11.

Important:  La migrazione di Bot Insight è supportata solo se il database è installato su Microsoft SQL
Server o se il Metadatabase è installato su Microsoft SQL Server o PostgreSQL Server. La migrazione di Bot
Insight non è supportata se il database è installato su PostgreSQL Server.
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Note:  After data is migrated from Enterprise 11 to Automation 360, ensure that the end-to-end migration
activity is completed within 90 days from the first day of data migration. After 90 days, the Bot Insight
analytical data will be deleted.

1. Scarica l'ultima versione dell'utilità di pre-migrazione Bot Insight dal sito di supporto Automation
Anywhere.

Important:  È necessario scaricare l'utilità sul dispositivo in cui Enterprise 11 Control Room è
installato.

a) Accedi alla pagina Download Automation Anywhere: A-People Downloads page (Login required).
b) Fai clic sul link per il download di Automation 360.
c) Open the Installation Setup folder and download the AAE_Export_BI_Dashboards_<

 version_number> file, for example, AAE_Export_BI_Dashboards_A360.23.jar.

See the following video on how to download the pre-migration utility:

2. Esegui l'utilità nel dispositivo Enterprise 11.
a) Apri il prompt dei comandi di Windows.
b) Esegui il comando seguente per esportare i dashboard Bot Insight in un file zip: java

 -jar "<path_of_downloaded_utility_jar/AAE_Export_BI_Dashboards_<
 version_number>.jar" -installationPath "<installation_path>/Enterprise"
 -outputDir "<path_to_save_zip_file>/dashboards"
Ad esempio: java -jar "Downloads/AAE_Export_BI_Dashboards_A360.23.jar "
 -installationPath "C:/Program Files/Automation Anywhere/Enterprise" -
outputDir "E:/AA/work/release/A360/migration/dashboard"
L'utilità genera il file dashboards.zip nella directory di output specificata.

Note:  È inoltre possibile utilizzare la doppia barra rovesciata (\\\\) per eseguire il file JAR.

3. Crea la cartella bot-insight nella posizione di installazione Automation 360.
Ad esempio, C:\Program Data\Automation Anywhere\Server Files\bot-insight
In questo percorso, C:\Program Data\Automation Anywhere\Server Files è un percorso
dinamico, che può essere qualsiasi posizione in base alle esigenze. La struttura della cartella che segue
il percorso dinamico (\bot-insight) è un percorso costante che non cambia.

4. Copia il file dashboards.zip disponibile nella posizione di output e incollalo nella cartella Server
 Files\bot-insight folder.

Dopo aver esportato i dashboard nell'archivio Automation 360, esegui le operazioni seguenti per la
migrazione dei dashboard Bot Insight.
1. Installa Automation 360 e accedi all'ambiente di gestione temporanea Automation 360.

Installing Control Room On-Premises on page 838
2. Esegui la migrazione di bots insieme ai dati Bot Insight e ai dashboard utilizzando Bot Migration

Wizard.
Migrazione dei bots di Enterprise on page 1216

See the following video on how to prepare Bot Insight data for migration:
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Esegui la migrazione dei log di audit Enterprise 11
L'utilità di esportazione dei log di audit consente di esportare i dati dei log di audit da Enterprise 11 Control
Room a un file JSON. Incolla il file JSON nell'archivio Automation 360, quindi migra i dati del log di audit.

Note:  Migration of audit logs from Enterprise 11 to Automation 360 is supported only for On-Premises
deployments.

Assicurati di disporre del ruolo AAE_Admin o dell'autorizzazione Gestisci migrazione.
• Starting with Automation 360 v.23, you can migrate audit log data of Version 11.3.5 or later versions.
• L'utilità di esportazione del log di audit esporta le informazioni su tutti gli eventi del log Enterprise 11,

compresi quelli attualmente non supportati in Automation 360, ad esempio l'autenticazione a più fattori
(MFA) e l'esecuzione dei bots tramite la riga di comando.

In base alla versione corrente del tuo Control Room, scegli uno dei seguenti modi per esportare e migrare i
dati del log di audit:
• Per Version 11.3 e versioni successive:

a) Scarica l'ultima versione dell'utilità di esportazione del log di audit dal sito di supporto Automation
Anywhere.

Important:  È necessario scaricare l'utilità sul computer in cui Version 11.3 Control Room è
installato. Se Control Room è installato in Modalità cluster, è possibile scaricare l'utilità su
qualsiasi nodo disponibile nel cluster.

a. Accedi alla pagina Download di Automation Anywhere: A-People Downloads page (Login
required).

b. Fai clic sul link Automation 360.
c. Click Installation Setup, and then click AAE_Export_Audit_Log_v2.zip file..

b) Estrai i file dal file zip scaricato.
c) Apri il prompt dei comandi di Windows.
d) Change the working directory to AAE_Export_Audit_Log_v2and enter the following

command: bin\java -jar AAE_Export_Audit_Log_v2.jar export.path="OUTPUT
 LOCATION" cr.version="CONTROL ROOM VERSION" install.path="CONTROL ROOM
 INSTALLATION PATH"

Aggiorna i seguenti valori nel comando:
• POSIZIONE DI OUTPUT: Sostituisci il testo con la posizione in cui desideri salvare l'output.

• Assicurati che le cartelle menzionate nella posizione esistano.
• Assicurati di specificare la posizione della cartella di output tra virgolette doppie.

• CONTROL ROOM VERSION: Replace the text with the current version of the Enterprise 11
Control Room that is installed. The cr.version value is the first three digits of the Enterprise
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11 Control Room. For example, if the Control Room is Version 11.3.4.4, enter the cr.version
value as 11.3.4.

• CONTROL ROOM INSTALLATION PATH: Replace the text with the full path of the location where
the Control Room is installed. For example, C:\Program Files\Automation Anywhere
\Enterprise.

Command example: bin\java -jar AAE_Export_Audit_Log_v2.jar export.path="C:
\Migration\Audit Log" cr.version="11.3.2" install.path="C:\Program Files
\Automation Anywhere\Enterprise"

L'utilità genera il file es_export.json nella posizione di output specificata. Il file JSON generato
contiene un massimo di 10000 record. Se sono disponibili più di 10.000 record nei dati di audit,
l'utilità genera più file JSON nella stessa posizione e aggiunge un suffisso come es_export_1.

e) Crea le cartelle migration\es-data nell'archivio Automation 360.
f) Copia il file JSON disponibile nella posizione di output.

Se l'utilità ha generato più file JSON, è necessario copiare tutti i file.
g) Incolla il file JSON nella cartella Server Files\migration\es-data.

See the following video on exporting 11.3.x audit log data for migration:

h) Accedi all'ambiente di gestione temporanea di Automation 360.
i) Vai ad Amministrazione > Migrazione.
j) Fai clic su Migra log di audit dal menu Migra bot in alto a destra nella schermata.

Il sistema inizia a recuperare e migrare i dati del log di audit dal file es_export.json e a caricarli
in Automation 360 Elasticsearch. Le voci vengono visualizzate nella scheda Log di audit di
Automation 360.
Una volta completata la migrazione del log di audit, passa alla pagina Amministrazione >
Migrazione per visualizzare lo stato della migrazione del log di audit e altre informazioni correlate.
Puoi anche filtrare i risultati della migrazione del log di audit in base al Tipo di migrazione come
Migrazione del log di audit.
Fai clic sull'opzione Visualizza migrazione per ogni istanza di migrazione di audit per visualizzare
informazioni aggiuntive come il percorso del file di log di audit e i motivi per cui i singoli file
es_export.json sono stati saltati o non sono stati migrati correttamente durante la migrazione
dei log di audit.
Visualizza i rapporti di migrazione on page 1299

• Per la versione 11.2 e precedenti:
a) Accedi all'ambiente di gestione temporanea di Automation 360.
b) Vai ad Amministrazione > Migrazione.
c) Fai clic su Migra dati audit da Migra bot in alto a destra nella schermata.

Il sistema inizia a recuperare e migrare i dati di audit dal database e a caricarli in Automation 360
Elasticsearch. Le voci vengono visualizzate nella scheda Log di audit di Automation 360.

See the following video on migrating Enterprise 11 audit log data:

Related tasks
Visualizza i rapporti di migrazione on page 1299
Utilizza i report per analizzare lo stato della migrazione bot individuale, della migrazione dei dati e della
migrazione dei log di audit e per identificare lo stato e il riepilogo della singola migrazione.
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Preparazione per la migrazione quando si utilizzano Enterprise 11 e
Automation 360 On-Premises in parallelo
Esegui le attività in questo flusso di lavoro se desideri utilizzare sia Automation 360 On-Premises sia
Enterprise 11 in parallelo. È possibile continuare a utilizzare entrambi gli ambienti fino a quando non si è
pronti ad avviare la migrazione da Enterprise 11 a Automation 360 On-Premises.
1. Assicurati di aver completato le attività seguenti per verificare la disponibilità alla migrazione

Controlla la preparazione alla migrazione on page 1135.
2. Assicurati di disporre e aver attivato la licenza di migrazione.

Ottenere la licenza di migrazione on page 1172
3. Se stai installando Automation 360 su un computer su cui Enterprise 11 era stato installato in

precedenza, è necessario eliminare i dati dalla cartella dati Elasticsearch situata in C:/ProgramData/
elasticsearch/data.
Se la posizione della cartella dati Elasticsearch è stata modificata, è possibile trovare le informazioni
aggiornate nel file C:\Program Files\Automation Anywhere\Enterprise\elasticsearch
\config\elasticsearch.yml.

Important:  Se si eliminano i dati Elasticsearch, i dati di audit di Enterprise 11 andranno persi.

Note:  Installa Automation 360 su un server separato per assicurare che l'ambiente Enterprise 11 non sia
interessato dalle attività di migrazione.

1. È consigliabile creare un backup del database Enterprise 11 e ripristinarlo nella stessa istanza SQL o
in una istanza SQL diversa per evitare errori di qualsiasi attività automatica che utilizza il database
Enterprise 11.
Quickstart: Back up and restore a SQL Server database on-premises

Migrazione Bot Insight: I dati Bot Insight e i dashboard vengono migrati come parte del processo
di migrazione generale. Per la migrazione, clona il database Bot Insight (che è diverso dal database
Enterprise 11 Control Room), estrai ed esporta i metadati del dashboard in Automation 360 utilizzando
l'utilità di pre-migrazione Bot Insight.
Esportazione di dashboard Enterprise 11 Bot Insight per la migrazione on page 1194

2. Se stai effettuando la migrazione dalla versione 11.3.x o da versioni successive, elimina i dati della
tabella ES_SETTINGS dal database della Control Room Enterprise 11.

3. Copia e incolla l’archivio Enterprise 11 Control Room e aggiorna l'URL di accesso e il percorso
dell’archivio.
Copiare e incollare le informazioni di Enterprise 11 in Automation 360 on page 1191

4. Assicurati che tutte le variabili delle credenziali utilizzate nei bots Enterprise 11 siano disponibili nella
Control Room Enterprise 11.
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5. Installazione di Automation 360 On-Premises:
a) Assicurati che i requisiti di sistema siano soddisfatti.

Automation 360 On-Premises prerequisites on page 840
b) Installa Automation 360 On-Premises Control Room in modalità personalizzata in un ambiente di

gestione temporanea.
Installing Control Room using Custom mode on page 902

Important:  Durante l'installazione, configura Automation 360 On-Premises Control Room per
utilizzare il database Enterprise 11 ripristinato.

6. Continua a utilizzare entrambi gli ambienti Enterprise 11 e Automation 360 in parallelo.

Note:  Crea tutti i nuovi bots e le nuove entità, quali utenti, ruoli e pianificazioni in Automation 360.

7. Se crei una nuova entità come utenti, ruoli o pianificazioni (ad eccezione di bots) in Enterprise 11 dopo
l'installazione di Automation 360, crea la stessa entità in Automation 360.

8. Quando sei pronto a utilizzare solo Automation 360 come ambiente di produzione:
a) Se sono stati creati nuovi bots in Enterprise 11 dopo l'installazione di Automation 360:

1. Esporta tutti i bots e le relative dipendenze create dopo l'installazione di Automation 360
utilizzando Bot Lifecycle Management.
Export bots

2. Importa tutti i bots in Automation 360 utilizzando Bot Lifecycle Management.
Importa bots on page 2837

9. Optional: Esegui la migrazione dei log di audit.
Esegui la migrazione dei log di audit Enterprise 11 on page 1196

Attività di prerequisito per la migrazione bots on page 1211

How workload management data is migrated
Enterprise 11 workload management data is automatically migrated to Automation 360 when you install
Automation 360 and point the Control Room to the restored Enterprise 11 database.
When you migrate workload management data to Automation 360, all related workload management is
moved to the Automation 360 environment, including queues, device pools, owners, and consumers. I pool
di dispositivi migrati sono vuoti perché il processo di migrazione non esegue la migrazione dei dispositivi.
Devi aggiornare il pool di dispositivi con i dispositivi Bot Runner non assistiti pertinenti.

Note:  Bots that are deleted in the workload management automation records are skipped during
migration. These bots are displayed as N/A in the workload queues.

I Bots associati a un modello di carico di lavoro vengono migrati nello stesso modello di Automation 360
con tutte le informazioni intatte.
Per la migrazione sono supportate le seguenti variabili degli elementi di lavoro:
• $WorkItem$: la modalità di migrazione di questa variabile dipende dalla stringa, dal numero e dal tipo

di data/ora ad essa associati.
Mappatura delle variabili per la migrazione on page 1279
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• $WorkItemResult$: i Bots che utilizzano questa variabile devono essere associati a un modello di carico
di lavoro in Enterprise 11 se desideri utilizzarli dopo la migrazione. Se esegui la migrazione di un bot
che ha la variabile $WorkItemResult$ in un comando e il bot non è collegato a un modello di carico di
lavoro, il comando restituirà un errore quando viene aperto in Bot editor in Automation 360.

Le seguenti operazioni di variabile dell'oggetto di lavoro non sono ancora supportate e i bots che utilizzano
queste variabili non possono essere migrati correttamente:
• Reimpostazione di $WorkItem$
• Reimpostazione $WorkItemResult$

Related tasks
Edit device pools on page 2638
As a Control Room user with device pool management privileges or as a device pool owner, you can edit
device pool details to customize your automation requirements.
Use Work Item variables on page 2038
You can use the Work Item variables to pass the Work Item attributes or values to the TaskBot from the
Control Room when you run the bot with the option Run bot with queue.

Preparare la migrazione manuale a Automation 360 On-Premises
Puoi eseguire manualmente la migrazione da Enterprise 11 a Automation 360 On-Premises creando utenti,
ruoli, autorizzazioni e altre entità necessarie affinché i bots possano essere eseguiti correttamente.
1. Assicurati di aver completato le attività seguenti per verificare la disponibilità alla migrazione

Controlla la preparazione alla migrazione on page 1135
2. Assicurati di disporre e aver attivato la licenza di migrazione.

Ottenere la licenza di migrazione on page 1172

Note:  Adotta la migrazione manuale nei seguenti scenari:
• Disponi di un'istanza esistente di Automation 360 On-Premises e vuoi migrare i tuoi dati Enterprise 11.
• Quando desideri eseguire solo la migrazione dei bots e ricreare manualmente tutte le altre entità di

Enterprise 11, ad esempio utenti, ruoli e credenziali, in Automation 360.
• Quando desideri eseguire solo la migrazione di alcune entità Enterprise 11. Ad esempio, se disponi di

50 utenti e di 10 ruoli definiti dall'utente in Enterprise 11 e desideri migrare solo 40 utenti e 7 ruoli in
Automation 360. Allo stesso modo, se desideri eseguire la migrazione solo di utenti e ruoli e ricreare le
pianificazioni richieste in Automation 360.

• When you want to migrate Enterprise 11 entities to Automation 360 using a freshly installed database
and server.

1. Installazione di Automation 360 On-Premises:
a) Assicurati che i requisiti di sistema siano soddisfatti.

Automation 360 On-Premises prerequisites on page 840
b) Installa Automation 360 On-Premises Control Room in modalità personalizzata in un ambiente di

gestione temporanea.
Installing Control Room using Custom mode on page 902

Important:  È necessario installare Automation 360 con un nuovo database.
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2. Crea tutte le entità Enterprise 11 in Automation 360 On-Premises.
Per ulteriori informazioni sulle entità da creare, consulta Prerequisiti per la migrazione manuale on page
1188.

3. Esporta tutti i bots e le relative dipendenze create dopo l'installazione di Automation 360 utilizzando
Bot Lifecycle Management.
Export bots

4. Carica i bots su Automation 360 On-Premises.
Importa bots on page 2837

Attività di prerequisito per la migrazione bots on page 1211

Preparazione per abilitare la migrazione da Enterprise 11 a
Automation 360
Esegui le attività in questo flusso di lavoro per eseguire la migrazione da Enterprise 11 a Automation 360
Cloud, inclusa la migrazione dei bots.
Se stai installando Automation 360 su un computer su cui Enterprise 11 è stato installato in
precedenza, si consiglia di eliminare i dati dalla cartella dati Elasticsearch situata in C:\ProgramData
\elasticsearchdata.

Note:  Se la posizione della cartella dati Elasticsearch è stata modificata, è possibile trovare le informazioni
aggiornate nel file C:\Program Files\Automation Anywhere\Enterprise\elasticsearch
\config\elasticsearch.yml.

1. Assicurati di aver completato le attività seguenti per verificare la disponibilità alla migrazione
Controlla la preparazione alla migrazione on page 1135.

2. Assicurati di disporre e aver attivato la licenza di migrazione.
Ottenere la licenza di migrazione on page 1172

1. Installa Automation 360 per distribuzione abilitata al Cloud.
Installing Control Room for Cloud-enabled deployment on page 976

2. Crea tutte le entità, ad esempio utenti, ruoli e credenziali, tranne bots nella Automation 360 stessa
modalità in cui sono disponibili in Enterprise 11.
Prerequisiti per la migrazione manuale on page 1188

3. Esporta tutte le dipendenze Enterprise 11 bots e le relative dipendenze che desideri migrare a
Automation 360 utilizzando Bot Lifecycle Management.
Export bots

4. Importa tutto Enterprise 11 bots in Automation 360 utilizzando Bot Lifecycle Management.
Importa bots on page 2837

5. Optional: Esegui la migrazione dei log di audit.
Esegui la migrazione dei log di audit Enterprise 11 on page 1196

Attività di prerequisito per la migrazione bots on page 1211
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Preparazione per la migrazione da Enterprise 11 a Automation 360
su Linux CentOS
Esegui le attività in questo flusso di lavoro per eseguire la migrazione da Enterprise 11 a Automation 360
On-Premises su Linux CentOS, inclusa la migrazione dei bots a Automation 360. Se Enterprise 11 bot è
abilitato per l'analisi, vengono migrati anche i dati Bot Insight e il dashboard di analisi aziendale.

Note:  Crea un nuovo ambiente per la migrazione a Automation 360 per evitare problemi ai bots esistenti
dovuti alle attività di migrazione.

1. È consigliabile creare un backup del database Enterprise 11 e ripristinarlo nella stessa istanza SQL o
in una istanza SQL diversa per evitare errori di qualsiasi attività automatica che utilizza il database
Enterprise 11.
Quickstart: Back up and restore a SQL Server database on-premises

2. Se si sta effettuando la migrazione da Version 11.3.5 o da versioni successive, è necessario eliminare i
dati della tabella ES_SETTINGS dal database Enterprise 11 Control Room.

3. Assicurati che tutte le variabili delle credenziali utilizzate nei bots Enterprise 11 siano disponibili nella
Control Room Enterprise 11.

4. Copia e incolla l’archivio Enterprise 11 Control Room:
a) Use the sudo mkdir -p /opt/automationanywhere/enterprise/appdata/ command

to create the required Automation 360 folders.
b) Use the sudo chmod -R 775 /opt/automationanywhere command to provide the required

permissions for the folders.
c) Use the sudo mv command to copy the Enterprise 11 repository and paste it in the

automationanywhere/enterprise/appdata/ location.

5. Aggiorna l'URL di accesso Control Room e il percorso dell'archivio eseguendo i seguenti comandi SQL
sul database Enterprise 11 ripristinato:
a) Per aggiornare l'URL di accesso: aggiorna il valore set CONFIGURATION = '[Automation360

 Control Room URL]' dove categoria = 'CR_setup_general' e config_key = 'AccessUrl'
Esempio di query: aggiorna il valore set [Automation360-Database].[dbo].[CONFIGURATION]
valore set ='http://Automation360-crurl.com' dove config_key='AcessUrl'

Note:  Non includere una barra ('/') alla fine dell'URL di accesso fornito nel comando precedente.

b) Per aggiornare il percorso dell'archivio: aggiorna il valore set CONFIGURATION = /opt/
automationanywhere/enterprise/appdata/Server Files dove config_key =
'RepositoryPath'

6. Installazione di Automation 360 On-Premises:
a) Assicurati che i requisiti di sistema siano soddisfatti.

Automation 360 On-Premises prerequisites on page 840
b) Installa Automation 360 On-Premises Control Room in modalità personalizzata in un ambiente di

gestione temporanea.
Installing Control Room on Linux on page 948

Important:  Durante l'installazione, configura Automation 360 On-Premises Control Room per
utilizzare il database Enterprise 11 ripristinato.
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7. Optional: Esegui la migrazione dei log di audit.
Esegui la migrazione dei log di audit Enterprise 11 on page 1196

Attività di prerequisito per la migrazione bots on page 1211

Preparazione per la migrazione Enterprise 10 a Automation 360
On-Premises
Esegui le attività in questo flusso di lavoro per eseguire la migrazione da Enterprise 10 a Automation 360
On-Premises, inclusa la migrazione di bots a Automation 360.
Workflow map: You can also view this migration workflow in an interactive visual format by clicking the

following schematic image:
1. Migrating from Enterprise 10 to Automation 360 On-Premises

1. Assicurati di aver completato le attività seguenti per verificare la disponibilità alla migrazione
Controlla la preparazione alla migrazione on page 1135.

2. Assicurati di disporre e aver attivato la licenza di migrazione.
Ottenere la licenza di migrazione on page 1172

Note:  Installa Automation 360 su un server separato per assicurare che l'ambiente Enterprise 10 non sia
interessato dalle attività di migrazione.

1. È consigliabile creare un backup del database Enterprise 10 e ripristinarlo nella stessa istanza SQL o
in una istanza SQL diversa per evitare errori di qualsiasi attività automatica che utilizza il database
Enterprise 10.
Quickstart: Back up and restore a SQL Server database on-premises

2. Assicurati che tutte le variabili delle credenziali utilizzate nei bots Enterprise 10 siano disponibili nella
Control Room Enterprise 10.
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3. Installazione di Automation 360 On-Premises:
a) Assicurati che i requisiti di sistema siano soddisfatti.

Automation 360 On-Premises prerequisites on page 840
b) Installa Automation 360 On-Premises Control Room in modalità personalizzata in un ambiente di

gestione temporanea.
Installing Control Room using Custom mode on page 902

Important:  È necessario installare Automation 360 con un nuovo database.

c) Configura in Automation 360 la stessa autenticazione di Enterprise 10.
Non cambiare i tipi di autenticazione tra Enterprise 10 e Automation 360. Ad esempio, se Active
Directory è impostato come autenticazione in Enterprise 10, è necessario configurare Active
Directory come autenticazione anche in Automation 360 .

4. Copia i dati Enterprise 10 in Automation 360.
Copia dati Enterprise 10 on page 1207

5. Crea il valore globale AAApplicationPath in Automation 360 e imposta lo stesso valore di Enterprise
10.
Migrazione da Enterprise 10 on page 1235

6. Completa le attività di pre-migrazione.
Attività di pre-migrazione

Migrazione dei bots di Enterprise on page 1216

Come vengono copiati i dati di Enterprise 10 in Automation 360
Gli utenti, i ruoli, le licenze, le credenziali, i bots e le pianificazioni di Enterprise 10 vengono copiati in
Automation 360 come parte del processo di copia dei dati.
I dati di Enterprise 10 vengono copiati nel seguente ordine:
1. Ruoli
2. Utenti
3. Credenziali
4. Bots
5. Programmi

Se il processo di copia salta un elemento della sequenza per qualsiasi motivo, anche tutti gli elementi
correlati saranno ignorati e non verranno migrati. Ad esempio, se il ruolo Bot_Manager non viene migrato
e l'utente Jane_Smith appartiene solo a tale ruolo, anche l'account utente e le credenziali di bots o i
programmi associati a tale ruolo non vengono migrati.
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Enterprise 10
elementi

Come vengono copiati gli elementi di Enterprise 10 in Automation 360

Utenti Quando si copiano gli utenti di Enterprise 10 per la prima volta, se il sistema
rileva in Automation 360 un utente con lo stesso nome, il processo di
migrazione rinomina il nome utente Enterprise 10 aggiungendo un suffisso
come _1, _2 e così via, quindi copia l'utente rinominato in Automation 360.
Ad esempio, un nome utente Jane_Smith duplicato viene rinominato come
Jane_Smith_1 in Automation 360. Le successive operazioni di copia dei dati
salteranno i dati utente precedentemente migrati.
Per gli utenti di Active Directory, il sistema non esegue la migrazione degli
utenti duplicati. Se un utente di dominio con lo stesso nome esiste già in
Automation 360, il processo di migrazione ignora tale utente e le relative
dipendenze.

Ruoli La prima volta che si copiano i ruoli di Enterprise 10, il processo di
migrazione gestisce i ruoli di sistema duplicati e i ruoli personalizzati in
modo differente. Il processo di migrazione mappa i ruoli di sistema di
Enterprise 10 ai ruoli di sistema di Automation 360. Ad esempio, i ruoli
Admin e Basic di Enterprise 10 vengono mappati rispettivamente al ruolo
AAE_Admin e al ruolo AAE_Basic.
Se in Enterprise 10 e Automation 360 esiste un ruolo personalizzato con lo
stesso nome, il processo di migrazione lo rinomina aggiungendo un suffisso
come _1, _2 e così via, quindi copia il ruolo rinominato in Automation 360.
Ad esempio, un ruolo Sales_Operations duplicato viene rinominato come
Sales_Operations_1 in Automation 360.
Le successive operazioni di copia dei dati salteranno i ruoli
precedentemente migrati.

Licenze Il processo di migrazione esegue automaticamente la migrazione delle
licenze allocate all'utente, ma queste non vengono visualizzate nel report
di migrazione. Se la Control Room di Automation 360 ha un numero di
licenze di Bot Creator o di Bot Runner inferiore rispetto a Enterprise 10
Control Room e tutte le licenze di Automation 360 sono state utilizzate, agli
utenti appena migrati non verrà allocata alcuna licenza. Il sistema esegue
la migrazione di questi utenti e dei dati correlati senza assegnare nuove
licenze.
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Enterprise 10
elementi

Come vengono copiati gli elementi di Enterprise 10 in Automation 360

Credenziali Per le credenziali di sistema associate a un utente migrato, il sistema
esegue la migrazione solo delle credenziali di sistema Impostazioni e-mail e
Impostazioni accesso automatico.
Per le credenziali create dall'amministratore di Control Room, il sistema
crea l'armadietto AAE_10x_Credentials in Automation 360 Credential
Vault e aggiunge le credenziali da Enterprise 10 come credenziali standard.
Il sistema assegna l'utente che migra i dati di Enterprise 10 come
proprietario dell'armadietto AAE_10x_Credentials e tutti i ruoli
personalizzati come consumatori dell'armadietto. Se un armadietto con
il nome AAE_10x_Credentials esiste già in Automation 360, il sistema
aggiunge le credenziali migrate in tale armadietto.

Note:
• La migrazione delle credenziali con oltre 50 attributi non è supportata.
• Agli utenti con il solo ruolo AAE_Basic assegnato in Enterprise 10 deve

essere concesso un ruolo personalizzato in Automation 360 per poter
essere un consumatore dell'armadietto AAE_10x_Credential.

Per MetaBots che contengono schermate come risorse e utilizzano variabili
di tipo password in queste schermate, le variabili di tipo credenziale
equivalenti vengono create in Automation 360. Se la variabile di tipo
password in MetaBot è una variabile di input e un valore per tale variabile
viene trasferito dalla variabile padre bot a Enterprise 10, completa la
seguente procedura prima di eseguire i bots migrati:
1. Crea le credenziali con l'opzione Standard selezionata come input.
2. Crea un armadietto e utilizza le credenziali create nel passaggio

precedente di tale armadietto.
3. Nel padre migrato bot, utilizza le credenziali create per trasferire tali

credenziali al figlio bots.

Se è stata utilizzata una variabile matrice all'interno di un loop per trasferire
più valori alla variabile di tipo password utilizzata in MetaBot, la migrazione
bot utilizza la credenziale creata per trasferire un singolo valore.

Bots Se un bot con lo stesso nome esiste in Enterprise 10 e Automation 360,
il processo di copia dei dati ignora la migrazione del bot e il programma
associato. Commands that use credential variables in Enterprise 10 bots use
the AAE_10x_Credentials locker after migration.
If your Enterprise 10 Control Room is configured with SVN version control,
then the copy data process also copies the latest version of each bot
including the dependencies from the Enterprise 10 repository to the
Automation 360 repository. Use the bot migration wizard to migrate the
Enterprise 10 bots to Automation 360. However, the version history of the
bot and its dependencies are not copied and migrated.

Note:  Migration of the production version of Enterprise 10 bots is currently
not supported. As a workaround, make or set the current production
version of the bots as the latest version and then migrate the bots.
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Enterprise 10
elementi

Come vengono copiati gli elementi di Enterprise 10 in Automation 360

Programmi Se esistono programmi duplicati in entrambi gli ambienti, il programma
duplicato viene migrato e darà come risultato due programmi con lo stesso
nome in Automation 360.
La migrazione dei programmi non riesce se l'utente associato non esiste in
Automation 360.

See the following video on how to review the copied Enterprise 10 data in Automation 360:

Related tasks
Copia dati Enterprise 10 on page 1207
È necessario copiare i dati Enterprise 10 in Automation 360 prima di convertire Enterprise 10 bots.
Abilita le pianificazioni dopo la migrazione on page 1242
Quando copi i dati Enterprise 10 in Automation 360, le pianificazioni Enterprise 10 vengono migrate.
Le pianificazioni Enterprise 11 delle versioni vengono migrate quando aggiorni i dati Enterprise 11 in
Automation 360.

Copia dati Enterprise 10
È necessario copiare i dati Enterprise 10 in Automation 360 prima di convertire Enterprise 10 bots.
L'utente che esegue questa attività deve avere il ruolo AAE_Admin.
1. Accedi all'ambiente di gestione temporanea di Automation 360.
2. Fai clic su Amministrazione > Migrazione.
3. Fai clic su Copia dati 10.x.
4. Immetti le seguenti informazioni nella pagina GENERALE.

Opzione Azione

Nome Immetti un nome di migrazione o utilizza quello
predefinito. Il nome della migrazione predefinito
mostra il nome dell'utente connesso, la data
corrente e il timestamp.

Descrizione Consente di immettere una descrizione per la
migrazione.

5. Fai clic su Avanti.
6. Immetti le seguenti informazioni nella pagina DATABASE.

Opzione Azione

Usa connessione sicura Seleziona questa opzione per utilizzare una
connessione sicura per connetterti al database.

Nome host server Immetti il nome host del server di database che
contiene i dati Enterprise 10 da migrare.

Porta server Immetti la porta de desideri utilizzare per
connetterti al server del database.
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Opzione Azione

Usa credenziali database Seleziona questa opzione per utilizzare le
credenziali del database per l'autenticazione
quando stabilisci una connessione con il server di
database.
Se è stata selezionata questa opzione, fornisci
le credenziali che si desideri utilizzare per
connetterti al server di database nei campi
Nome utente e Password.

Usa autenticazione Windows Seleziona questa opzione per utilizzare
l'autenticazione Windows e stabilire una
connessione con il server di database.

Important:  Questa opzione funziona solo se è
stato configurato un account di dominio durante
l'installazione e che dispone di autorizzazioni di
lettura e scrittura per il database Enterprise 10.

Nome database Immetti il nome del database che contiene i dati
Enterprise 10 da migrare.

Connetti Fai clic su questa opzione per stabilire una
connessione con il database.

7. Fai clic su Avanti.
8. Immetti le seguenti informazioni nella pagina ARCHIVIO.

Opzione Azione

Percorso archivio Immetti la posizione dei dati Enterprise 10
ripristinati disponibili sul dispositivo.

Chiave master Immetti la chiave master per Enterprise 10.

Convalida Fai clic su questa opzione per convalidare la
connessione prima di copiare i dati Enterprise 10.

9. Fai clic su Copia dati.

See the following video on how to copy Enterprise 10 data to Automation 360:

Crea il valore globale AAApplicationPath in Automation 360
Related concepts
Come vengono copiati i dati di Enterprise 10 in Automation 360 on page 1204
Gli utenti, i ruoli, le licenze, le credenziali, i bots e le pianificazioni di Enterprise 10 vengono copiati in
Automation 360 come parte del processo di copia dei dati.
Related tasks
Abilita le pianificazioni dopo la migrazione on page 1242
Quando copi i dati Enterprise 10 in Automation 360, le pianificazioni Enterprise 10 vengono migrate.
Le pianificazioni Enterprise 11 delle versioni vengono migrate quando aggiorni i dati Enterprise 11 in
Automation 360.
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Preparazione per la migrazione quando si utilizzano Enterprise 10 e
Automation 360 On-Premises in parallelo
Esegui le attività in questo flusso di lavoro se desideri utilizzare sia Automation 360 On-Premises sia
Enterprise 10 in parallelo. È possibile continuare a utilizzare entrambi gli ambienti fino a quando non si è
pronti ad avviare la migrazione da Enterprise 10 a Automation 360 On-Premises.
1. Assicurati di aver completato le attività seguenti per verificare la disponibilità alla migrazione

Controlla la preparazione alla migrazione on page 1135.
2. Assicurati di disporre e aver attivato la licenza di migrazione.

Ottenere la licenza di migrazione on page 1172

Note:  Crea un nuovo ambiente per la migrazione a Automation 360 per evitare problemi ai bots esistenti
dovuti alle attività di migrazione.

1. È consigliabile creare un backup del database Enterprise 11 e ripristinarlo nella stessa istanza SQL o
in una istanza SQL diversa per evitare errori di qualsiasi attività automatica che utilizza il database
Enterprise 11.
Quickstart: Back up and restore a SQL Server database on-premises

2. Assicurati che tutte le variabili delle credenziali utilizzate nei bots Enterprise 11 siano disponibili nella
Control Room Enterprise 11.

3. Installazione di Automation 360 On-Premises:
a) Assicurati che i requisiti di sistema siano soddisfatti.
b) Installa Automation 360 On-Premises Control Room in modalità personalizzata in un ambiente di

gestione temporanea.
Installing Control Room using Custom mode on page 902

Important:  È necessario installare Automation 360 con un nuovo database.

4. Completa le attività di pre-migrazione.
Attività di pre-migrazione

5. Crea il valore globale AAApplicationPath in Automation 360 e imposta lo stesso valore di Enterprise
10.
Mappatura delle variabili per la migrazione on page 1279

6. Copia i dati Enterprise 10 in Automation 360.
Copia dati Enterprise 10 on page 1207

7. Continua a utilizzare entrambi gli ambienti Enterprise 10 e Automation 360 in parallelo.

Note:  Crea tutti i nuovi bots e le nuove entità, quali utenti, ruoli e pianificazioni in Automation 360.

8. Se crei una nuova entità come utenti, ruoli, pianificazioni e bots in Enterprise 10 dopo l'installazione di
Automation 360, crea la stessa entità in Automation 360.
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9. When you are ready to use only Automation 360 as your production environment:
If you have created new bots or updated the existing ones in Enterprise 10 after installing Automation
360, based on your environment, follow these steps:
• Applies from v.24 onwards:

a. Export all the bots and their dependencies that were created after Automation 360 was
installed using the export utility.
Migrazione di Enterprise 10 bots nuovi o aggiornati su Automation 360 on page 1210

b. Import all the bots to Automation 360 using Bot Lifecycle Management.
Importa bots on page 2837

• Applies to v.23 and previous versions
a. Copy all the bots and their dependencies from Enterprise 10 by using the Copy 10.x data

option in the Automation 360.
b. Login as the Bot Creator to upload the bots and their dependencies to the Automation 360

private workspace. Note that the folder structure of the bots and their dependencies must be
same as that of version Enterprise 10.

c. Check in the bots to the public workspace.

Migrazione dei bots di Enterprise on page 1216

Migrazione di Enterprise 10 bots nuovi o aggiornati su Automation 360
L'utilità di esportazione Enterprise 10 ti permette di eseguire la migrazione di Enterprise 10 bots nuovi o
modificati su Automation 360 dopo una migrazione precedente.
Usa l'utilità di esportazione per creare un pacchetto .aapkg che può essere importato usando Bot
Lifecycle Management e poi migrato usando Bot Migration Wizard in Automation 360.
1. Scarica la versione più aggiornata dell'utilità di esportazione di bot dal sito di supporto Automation

Anywhere.
a) Accedi alla pagina Download di Automation Anywhere: A-People Downloads page (Login required).
b) Fai clic sul link Automation 360.
c) Fai clic su Installazione e configurazione e poi fai clic sul file

AAE_Export_Legacy_Bots_v1.zip.

2. Estrai i file dal file zip scaricato.
3. Apri il prompt dei comandi di Windows.
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4. Cambia la directory di lavoro in AAE_Export_Legacy_Bots_v1 e inserisci il seguente comando:
bin\java -jar AAE_Export_Legacy_Bots_v1.jar -INPUT="INPUT LOCATION" -
OUTPUT="OUTPUT LOCATION" -INCLUDE_SUBFOLDERS

Aggiorna i seguenti valori nel comando:
• INPUT: sostituisci il testo con il percorso del file o della cartella dell'archivio Control Room da cui i

file bot (file .atmx e .mbot) devono essere esportati.
• Assicurati che le cartelle menzionate nella posizione esistano.
• Assicurati di specificare la posizione della cartella di input tra virgolette doppie.

• OUTPUT: sostituisci il testo con un percorso di output in cui desideri memorizzare i file bot esportati
in un pacchetto (.aapkg) con un timestamp.
• Assicurati che le cartelle menzionate nella posizione esistano.
• Assicurati di specificare la posizione della cartella di output tra virgolette doppie.

• INCLUDE_SUBFOLDERS: fornisci questo parametro opzionale per indicare se i file bot delle
sottocartelle annidate dell'archivio Control Room devono essere esportate o meno.

Command example to export folder: bin\java -jar AAE_Export_Legacy_Bots_v1.jar -
INPUT="E:\Migration10x\Automation Anywhere Server Files\Default\Automation
 Anywhere\My Tasks\10X\Sample_Tasks" -OUTPUT="F:\10x-Export-Utility
\Exported-Bots"
Command example to export file: bin\java -jar AAE_Export_Legacy_Bots_v1.jar -
INPUT="E:\Migration10x\Automation Anywhere Server Files\Default\Automation
 Anywhere\My Tasks\10X\AutomationTask.atmx" -OUTPUT="F:\10x-Export-Utility
\Exported-Bots"
L'utilità genera il file .aapkg nella posizione di output specificata.

5.

1. Vai a Automazione > Importa bot per importare il file del pacchetto .aapkg in Automation 360.
Importa bots on page 2837

2. Vai a Amministrazione > Migrazione per eseguire la migrazione dei bots (convertire il file .atmx
in file .bot) in Automation 360 utilizzando Bot Migration Wizard.
Migrazione dei bots di Enterprise on page 1216

Attività di prerequisito per la migrazione bots
After you have set up Automation 360, you must perform certain tasks before migrating the Enterprise 11
or Enterprise 10 bots.
• Licenses:

• For migration to be successful, the license requirements of the target  environments must match the
existing source  or  environments.

• At least one  license is required for migration.
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• Roles:
Assign the AAE_Bot Migration Admin role to the user who will initiate the migration and the Bot
Runner user who will perform the migration. The Bot Runner user who runs the migration must have
the following permissions and criteria:
• Licenza Bot Runner non assistito
• Stato Accesso automatico impostato
• Dispositivo predefinito configurato

See the following video on how to create an Admin user to initiate bot migration:

See the following video on how to create a Bot Runner user to perform the bot migration:

• Control Room settings:
• Enterprise 11 users who have installed Automation 360 using a fresh database and Enterprise

10 users who have not copied Enterprise 10 data must manually create all the Enterprise 11 or
Enterprise 10 entities, except bots, in Automation 360. See information about the entities you must
create, see Prerequisiti per la migrazione manuale on page 1188.

• Bot Agent: Install the Bot Agent on the device that you want to use for migration: Installazione di Bot
Agent e registrazione del dispositivo on page 1039.
See the following video on how to install the Bot Agent on the device identified for bot migration:

• Bots: To migrate the production version of bots, import the Enterprise 11 bots using the Bot Lifecycle
Management feature from the SVN version control enabled Enterprise 11 Control Room. Consulta
Importa bots on page 2837.

Next steps

Migrazione dei bots di Enterprise on page 1216

Migrazione e la convalida dei bots
Esegui le attività in questo flusso di lavoro per convertire i bots al formato Automation 360 e convalidarli
dopo la migrazione.
Assicurati di aver completato tutte le attività sulla preparazione del tuo ambiente Automation 360 alla
migrazione: Preparazione della nuova Control Room per la migrazione on page 1174.

1. Migra i bots Enterprise 11 e Enterprise 10 a Automation 360: Migrazione dei bots di Enterprise on page
1216.
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2. Verifica che la migrazione sia completata correttamente:
• Visualizza i rapporti di migrazione on page 1299
• Verificare la migrazione bot on page 1299
• Esporta in CSV on page 1301
• Visualizzazione delle modifiche ai bots migrati utilizzando Bot Assistant on page 1301

See also the following video on migrating, testing, and updating your migrated bots:

Bot Migration Wizard
Questa procedura guidata è integrata in Control Room in Automation 360 e ti guida nel processo di
migrazione dopo che hai completato i prerequisiti. You can migrate multiple bots and their dependent bots
using this wizard.
Bot Migration Wizard esegue la migrazione di un bot solo se tutti i componenti utilizzati in bot sono
supportati per la migrazione. Se un bot utilizza altri file dipendenti come .txt, .doc e .png, è necessario
aggiungere manualmente questi file come dipendenze dopo la migrazione di bots.
Puoi anche utilizzare la migrazione Bot package per eseguire la migrazione di singoli bots. Tuttavia, si
consiglia di non utilizzare questo package perché non esegue la migrazione delle dipendenze bot e di altre
entità necessarie per eseguire il bot dopo la migrazione.
In the Control Room (Administration > Migration > Overview) tab, you can get a consolidated view
of the status of migrated bots.

Scheda Panoramica
Important:  Devi disporre delle autorizzazioni
Visualizza migrazione e Gestisci migrazione
per visualizzare questa scheda.

Puoi visualizzare lo stato generale della migrazione
bot, compresi i seguenti dettagli:
• Bots di cui è stata eseguita correttamente la

migrazione
• Bots di cui non è stata eseguita correttamente la

migrazione
• Bots di cui è stata eseguita la migrazione con un

messaggio di revisione
• Bots di cui è stata eseguita la migrazione con un

messaggio di azione richiesta
• Cronologia della migrazione: Informazioni sulle

migrazioni passate che sono state eseguite da
una cartella specifica o da tutte le cartelle.

Puoi inoltre effettuare le seguenti operazioni:
• Rieseguire la migrazione su bots selezionati

visualizzando in tal modo la cronologia di ciascun
bot che ha subito più migrazioni.

• Visualizzare l'ora in cui è stata eseguita la
migrazione del bot usando il timestamp.

• Ottenere un conteggio riassuntivo dei bots di cui
è stata eseguita correttamente la migrazione,
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di cui non è stata eseguita correttamente la
migrazione e per cui è necessaria una revisione
o azione da parte tua.

• Esportare un elenco specifico di bots.
• Visualizza la versione del bot migrato.
• Visualizza la cronologia delle versioni del bot

migrato (il messaggio di check-in indica che
il bot è migrato dalle versioni Enterprise 10 e
Enterprise 11 legacy).

To view the updated status of the remigrated bot, you can refresh either the table or the screen, shown in
the following

image.
Guarda il video seguente per scoprire come convertire Enterprise 11 o bots 10.x in formato .atmx
and .mbot in formato .bot in Automation 360. Puoi eseguire questa operazione dopo aver replicato il
database Enterprise 11 o Enterprise 10 e i bots sono disponibili in Automation 360 Control Room.
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Considerazioni relative alla migrazione e convalida dei bots
Il processo di migrazione è stato progettato per garantirne la fluidità. Scopri cosa devi aspettarti durante la
conversione, la convalida e la migrazione dei bots, in modo da eseguire i processi automatizzati quotidiani
come di consueto.

Time taken for migration Il tempo di migrazione varia in base al numero di
bots nell'archivio Enterprise 11 o Enterprise 10, al
numero di processi automatizzati e al numero di Bot
Runners e computer che eseguono la migrazione. Il
tempo necessario per eseguire la migrazione varia
in base ai processi e ai requisiti interni.

Note:  After data is migrated from Enterprise 11
to Automation 360, ensure that the end-to-end
migration activity is completed within 90 days from
the first day of data migration. After 90 days, the
Bot Insight analytical data will be deleted.

The following factors impact the time taken for
migration:
• Number and complexity of bots
• Number of lines in a bot
• Control Room and Bot Agent configuration
• Current load on Control Room (indicated by the

number of users connected to a Control Room at
a specific time)

• Migration environment: whether migration is
being performed on an isolated production or
staging environment.
Migration in an isolated environment occurs
faster.

• Whether the bots to be migrated are located
in a single folder or are located across multiple
folders
Bots present in a single folder are migrated
faster.

• Hardware requirements of the device from
where the migration is performed

• Network bandwidth
• Public repository size: When you run the Bot

Migration Wizard on a Git public repository that
is larger than 1 GB and contains more than
50,000 files or objects, the migration time might
be impacted.

Migrazione secondo il tuo ritmo Gli strumenti di migrazione ti permettono di
controllare quali elementi migrare e quando
eseguire la migrazione. Puoi scegliere di eseguire
la migrazione di tutti bots contemporaneamente
o di alcuni bots alla volta. Durante il periodo di
transizione da Enterprise 11 o Enterprise 10 a
Automation 360, puoi continuare a eseguire i bots
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sulla piattaforma precedente come di consueto fino
al completamento della migrazione.

Note:  Al termine della migrazione, tutti i nuovi
bots devono essere basati su Automation 360.
Questo ti aiuterà a gestire i bots e l'organizzazione
nella transizione.

Tempi di inattività pari a zero La migrazione non influisce sui bots pianificati
o sulla capacità di eseguire bots secondo la
pianificazione su Enterprise 11 o Enterprise 10
quando esegui la migrazione dei dati su Automation
360. Purché i requisiti dell'infrastruttura vengano
soddisfatti in base alle tue esigenze di automazione,
e purché si esegua Enterprise 11 o Enterprise 10
e Automation 360 in parallelo, le normali attività di
automazione non dovrebbero interrompersi.

Esecuzione di Enterprise 11 oEnterprise 10 e
Automation 360 in parallelo

Durante il periodo di transizione, consigliamo ai
clienti di eseguire l'automazione su Enterprise 11
o Enterprise 10 fino a quando la migrazione dei
bots non viene testata e eseguita correttamente
su Automation 360. Questo è il modo migliore per
garantire tempi di inattività pari a zero.

Migrazione dei bots di Enterprise
The bot migration process uses the Bot Migration Wizard to convert Enterprise 11 or Enterprise 10 bots
(TaskBots and MetaBots) in .atmx and .mbot format to the .bot format used in Automation 360 and
uploads the successfully migrated bots to the Control Room public workspace.
Assicurati di aver completato tutte le attività preliminari per la migrazione dei bots: Attività di prerequisito
per la migrazione bots on page 1211.
Durante la migrazione, tutte le dipendenze manuali dei bots vengono automaticamente convertite in
dipendenze di Control Room. L'azione Copia file di Control Room consente di copiare queste dipendenze
da Control Room nelle rispettive posizioni.
1. Accedi all'ambiente di gestione temporanea di Automation 360.
2. Fai clic su Amministrazione > Migrazione.

Note:  Se hai eseguito la migrazione dei bots da Enterprise 10 a Enterprise 11, le informazioni relative
a tale migrazione non saranno visualizzate nella pagina Elenco di migrazione.
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3. Nella schermata Bot Migration Wizard, fai clic su Esegui la migrazione dei bot.

4. Select the options and configuration as required in the the Settings tab.
Opzione Azione

Nome Immetti un nome di migrazione o utilizza quello
predefinito. Il nome della migrazione predefinito
mostra il nome dell'utente connesso, la data
corrente e il timestamp.

Descrizione Consente di immettere una descrizione per la
migrazione.

Sovrascrivi se esiste un bot con lo stesso
nome

Seleziona questa opzione per sovrascrivere un
bot esistente se nella cartella esiste un bot con lo
stesso nome.
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Opzione Azione

Exclude bot dependencies Select this option to exclude child bots of sub-
tasks from migration or updating. By selecting
this flag, you can now choose to migrate parent
and child bots separately or independently.

Usa il comportamento legacy della "Riga
Cella Excel"

Seleziona questa opzione se stai effettuando
la migrazione da una versione precedente
alla versione 11.3.0 o desideri mantenere il
comportamento legacy della variabile di sistema
Riga Cella Excel.

Use outgoing Email server settings Select this option if your bot contains the Send
Email command. Use these settings to specify the
type of email server to use.

Include web service settings Select this option for custom proxy configuration
support. When you select this option, the REST
commands with Custom proxy configurations
that use the following global variables are
migrated:
• AAProxyHost for Hostname
• AAProxyPort for Port

Conversione dei bot costruiti usando
Internet Explorer in Edge con la modalità
Internet Explorer

Seleziona questa opzione se desideri migrare bots
Enterprise 10 o Enterprise 11 che usano Internet
Explorer in bots Automation 360 che si servono di
Microsoft Edge in modalità IE.

Convert \n characters to \r\n in Log to File
action

Select this option to convert \n characters (LF)
into \r\n characters (CRLF), which automatically
take new line in migrated bots using Log to File
action.

Tag bots and variables for analytics Select this option when Bot Insight data exists
in the Enterprise 11 bots, and you also want to
migrate the Bot Insight data with those bots.
When you select this option, the Bot Insight
Open and Close actions are created.

Note:  To migrate Bot Insight data, you must
enable this option.

When you migrate Bot Insight data along with
bot migration, ensure that the Bot Insight
prerequisites are met.Bot Insight prerequisites |
Cloud Migration Utility prerequisites

If the Bot Insight prerequisites are not met,
Cloud migration with Bot Insight might become
stuck in the In Progress state.
Also, regardless of whether the Bot Insight and
the Cloud Migration utility prerequisites are
met or not, import or upload of the .atmx file
> Migrate. This issue is observed on both On-
Premises and Cloud deployments.
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5. Fai clic su Avanti.
6. Seleziona i bots e le cartelle che contengono i bots (TaskBots e MetaBots) che desideri migrare.

La possibilità di selezionare una cartella elimina lo sforzo richiesto per selezionare i singoli bots da tale
cartella.
• Se hai selezionato una cartella, tutte le sottocartelle all'interno di tale cartella e i bots all'interno di

queste sottocartelle vengono selezionati automaticamente per la migrazione.
• Se la cartella è vuota, il processo di migrazione rileva un errore.

La colonna Ultima migrazione indica quando il bot è stato migrato in precedenza. N/A (N/D) indica
che il bot non è stato migrato in precedenza.

7. Fai clic su Avanti.
8. Seleziona uno o più nomi utente dall'elenco per eseguire la migrazione e fai clic sulla freccia destra.

I nomi utente possono visualizzare il messaggio Scelto in fase di esecuzione o il nome del
dispositivo nella colonna Dispositivo. Un nome del dispositivo indica il dispositivo registrato per tale
utente. L'impostazione Scelto in fase di esecuzione viene visualizzata quando un utente non
dispone di un dispositivo predefinito, ad esempio nel caso in cui un utente non abbia registrato un
dispositivo e un amministratore di sistema gliene abbia assegnato uno. Devi configurare un dispositivo
predefinito per tutti i Bot Runners selezionati.
• I Bots vengono distribuiti tra utenti di Bot Runner selezionati in un metodo round-robin.
• Il primo utente di Bot Runner dell'elenco selezionato è il primo utilizzato.
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• Un bot padre e le relative dipendenze vengono assegnate a un singolo utente Bot Runner.

9. Fai clic su Avanti.
10. Optional: Prima di eseguire la migrazione, rivedi i TaskBots e i MetaBots dipendenti nella pagina Bot e

bot dipendenti.
Se hai selezionato una cartella e bots dalla pagina Bot, tale cartella e le dipendenze dei bots
selezionati vengono visualizzate nella tabella.
I bots (TaskBots e MetaBots) vengono migrati prima del bot primario.
La tabella mostra il bot primario nella parte inferiore con le relative dipendenze in quella superiore.
Ad esempio, le seguenti informazioni indicano che Sample05.atmx ha una dipendenza su
Sample04.atmx e Sample04.atmx ha una dipendenza su MessageBox.atmx e MetaTask.mbot.

Tipo Nome Percorso

MetaBot (mbot) MetaTask.mbot Bots\I miei Metabot
\MetaTask.mbot

TaskBot (atmx) MessageBox.atmx Bots\MyTasks
\MessageBox.atmx

TaskBot (atmx) Sample04.atmx Bots\MyTasks
\Sample04.atmx
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Tipo Nome Percorso

TaskBot (atmx) Sample05.atmx Bots\MyTasks
\Sample05.atmx

11. Fai clic su Esegui la migrazione dei bot.
Il sistema verifica se l'utente che ha avviato la migrazione e gli utenti Bot Runner selezionati
dispongono delle autorizzazioni necessarie per eseguire la migrazione. Il sistema verifica se tutte le
seguenti autorizzazioni sono concesse all'utente che esegue la migrazione e ai Bot Runners selezionati:
• Utente che esegue la migrazione:

• Autorizzazione Visualizza migrazione
• Autorizzazione Gestisci migrazione
• Autorizzazione per le cartelle contenenti i bots e MetaBots da migrare
• A role that has access to Bot Runners that you want to select for running the migration (on the

Administration > Migration > Run As page)
• Autorizzazione Visualizza e modifica il valore degli attributi di TUTTE le credenziali

• Bot Runners:
• Licenza Bot Runner non assistito
• Stato Accesso automatico impostato
• Autorizzazione Consenti a un utente esecutore di bot di eseguire migrazioni
• Autorizzazione Crea attributi standard per una credenziale
• Autorizzazione Crea cartella
• Autorizzazione Visualizza pacchetto
• Autorizzazione Registra dispositivo
• Autorizzazioni Visualizza i miei bot ed Esegui i miei bot
• Autorizzazioni Archivia ed Estrai per le cartelle Le mie attività e I miei Metabot in

Automation 360
• Impostazioni del dispositivo predefinito

Se una delle autorizzazioni richieste non viene concessa, il sistema visualizza tali autorizzazioni
nei risultati della convalida. Devi concedere le autorizzazioni necessarie e riavviare il processo di
migrazione.
Se agli utenti vengono concesse tutte le autorizzazioni richieste, il sistema inizia la migrazione dei bots
selezionati e dei bots dipendenti.
Dopo la migrazione, il sistema carica i bots migrati correttamente, i dati Bot Insight associati e i
dashboard pubblicati nello spazio di lavoro pubblico di Control Room Automation 360 (nella stessa
cartella in cui è disponibile il file .atmx). Nello spazio di lavoro pubblico vengono memorizzate solo le
migrazioni dei bot avviate da Control Room.
I dettagli degli errori di convalida per ogni bot sono visualizzati nei risultati della migrazione dei bot. I
dettagli dell'errore includono il numero di riga, i dettagli dell'errore, il motivo e le raccomandazioni.
I risultati della migrazione dei Bot mostrano il numero di bots migrati, insieme ai loro stati individuali.
Fai clic sulla colonna Stato per filtrare i bots con stati specifici per una rapida analisi.
Nella colonna Motivi, fai clic sull'opzione Visualizza problemi con la migrazione per vedere
in dettaglio i motivi dell'errore. La finestra di dialogo Visualizza problemi con la migrazione
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visualizza il numero di riga in cui si è verificato l'errore, un riepilogo dell'errore e un rapporto
dettagliato dell'errore per la revisione da parte dell'utente.
a) Estrai il bot per eseguire la migrazione dei dashboard privati associati a tale bot.

I dashboard privati vengono migrati solo per l'utente che ha estratto il bot associato per la prima
volta.

b) View in-progress migration activities from the Activity > In progress page.

See the following video on how to migrate Enterprise 11 or Enterprise 10 bots:

Consulta le seguenti risorse se riscontri un errore durante la migrazione:
• Migration error: Physical bot files aren't available (A-People login required)
• Migration error: Unable to download the source bot file for conversion (A-People login required)
• Migration shows unsuccessful by creating duplicate atmx files (A-People login required)
• Unable to migrate due to java.lang.StackOverflowError exception (A-People login required)
• Migration error: Unable to delete the file MigrationBot (A-People login required)

Verificare la migrazione bot on page 1299 | Visualizza i rapporti di migrazione on page 1299
Related tasks
Visualizza i rapporti di migrazione on page 1299
Utilizza i report per analizzare lo stato della migrazione bot individuale, della migrazione dei dati e della
migrazione dei log di audit e per identificare lo stato e il riepilogo della singola migrazione.
Esportazione di dashboard Enterprise 11 Bot Insight per la migrazione on page 1194
Utilizza l'utilità di pre-migrazione Bot Insight per esportare i metadati del dashboard Enterprise 11 Bot
Insight (widget e layout) e il profilo del dashboard come file zip. Esegui questa utilità nel dispositivo
Enterprise 11 e incolla il file zip nell'archivio Automation 360 per migrare i dashboard Bot Insight.
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Come viene eseguita la migrazione di MetaBots
Quando esegui la migrazione di un MetaBot a Automation 360, bots viene creato un equivalente per la
varie logica disponibile in MetaBot, ad eccezione delle schermate dell'applicazione. Dopo aver eseguito
correttamente la migrazione, ogni logica in un file .mbot viene convertita in un file TaskBot.
Un MetaBot contiene asset e logica. Gli asset sono le schermate dell'applicazione o DLL utilizzate per
automatizzare un'attività su un'applicazione. La logica è un set di comandi per eseguire un'operazione e
interagire con altre logiche e bots.

Note:
• Before you migrate .atmx or .mbot using the Bot Migration Wizard, ensure that all the Logics,

dlls, .mbots, .atmx files and other dependencies related to the MetaBots or TaskBots that were
previously migrated are not in the Checked-out state. Otherwise, the following error occurs during re-
migration:
Bot is not ready for migration.

The details of the unsuccessful migration are displayed in the Bot Migration wizard > Results >
Skipped tab.

• If the bot that you are migrating has been checked out or has been migrated previously, ensure that
the bot to be migrated is in the Checked-in state. Also, to reuse the migrated bot, in the Bot Migration
Wizard, select the Overwrite if a bot with same name exists option. To use an updated bot,
disable the Overwrite if a bot with same name exists option.

Il processo di migrazione esegue le seguenti operazioni:
• Converte la logica MetaBot nella TaskBots corrispondente.
• Mantiene la struttura della cartella di MetaBots dopo la migrazione. Le nuove cartelle create in

Automation 360 contengono TaskBots per ogni logica migrata a Automation 360.
• Aggiorna il TaskBots che utilizza la logica MetaBot per fare riferimento alla nuova TaskBots creata per la

logica MetaBot migrata.
Non è necessario aggiornare TaskBots manualmente.

Funzionalità come l'uso di DLL, variabili di input e output e l'autorizzazione Esegui che erano disponibili
solo per MetaBots sono ora disponibili per tutti i TaskBots.

Utilizzeremo il seguente MetaBot per spiegare come viene migrata a Automation 360:
• Nome MetaBot: MetaTask
• Risorse:

• Schermata di accesso
• General.dll
• DLL\Binary.dll

• Logica:
• Comune
• Process1\Connect
• Process1\Disconnect
• Process1\Operations\Numeric
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Vantaggi dei TaskBots riutilizzabili in Automation 360

The following table lists the benefits of using reusable TaskBots in Automation 360 compared with
MetaBots in Enterprise 11:

TaskBots riutilizzabili in Automation 360 MetaBots v11

Per risparmiare tempo, puoi utilizzare il
componente Finder per accedere a un bot
figlio con meno clic. Vai a Editor > Finder per
navigare fino al bot figlio.

You must navigate through the TaskBot > Run
action to reach the child bot.

Puoi cercare i bots figlio sia nell'area di lavoro
privata che in quella pubblica per utilizzarli in
TaskBots.

Per utilizzare un bot figlio in TaskBots, devi
eseguire il download di MetaBots nell'archivio
locale.

Per ogni attività è necessario distribuire solo una
Logic specifica, con un conseguente risparmio di
tempo e larghezza di banda.

L'intero MetaBot viene distribuito nella macchina
Bot Runner anche se solo una Logic è utilizzata
nell'attività.

Fornisce un RBAC migliore, che consente di
personalizzare le autorizzazioni.

MetaBots consente di avere le stesse
autorizzazioni per tutte le Logic, anche in
presenza di più Logic distribuite in cartelle
diverse.

Processo di migrazione MetaBot

Il sistema crea una cartella con lo stesso nome di MetaBot all'interno della cartella My MetaBots
disponibile nella cartella Bot e viene mantenuta la stessa struttura di cartelle di Enterprise 11. Ad esempio,
se la struttura di cartelle in Enterprise 11 è Accounts/Tax/MetaTask.mbot, il sistema mantiene la
struttura di cartelle di Accounts/Tax/MetaTask.mbot. Tutti i componenti di un MetaBot vengono
archiviati nella cartella creata per tale MetaBot. In questo esempio, il sistema crea la cartella MetaTask
nella cartella Bots\My MetaBots e archivia tutti i componenti MetaBot in tale cartella.
I bots Enterprise 10 che richiamano direttamente le DLL e le schermate in un MetaBot senza utilizzare
la logica MetaBot vengono migrati a TaskBots e actions equivalenti in Automation 360. In Enterprise 10,
se una DLL che restituisce un elenco o parametri di tipo array e l'output di tale DLL è mappato con un
parametro di tipo valore, viene aggiunto uno spazio aggiuntivo all'inizio del valore di output. Lo spazio
aggiuntivo non si somma al valore di output dopo la migrazione di bot.
10.1 MetaBots che utilizzano funzioni DLL in grado di supportare parametri di input di tipo lista e matrice
monodimensionale e che sono mappati con parametro di tipo matrice. In tali casi, è necessario inserire
l'indice di riga e di colonna per specificare il valore da restituire. Dopo la migrazione, l'indice di riga viene
considerato come numero di colonna.

Note:  Per bots aggiornati da 10.1 a 10.3.5 e quindi migrati a Automation 360, Bot Migration Wizard non
mostra la dipendenza sulla pagina Bot e bot dipendenti. Per tale tipo di bots, devi migrare i MetaBots
prima di migrare i TaskBots che stanno richiamando quei MetaBots.

Migrazione delle DLL

Il sistema non mantiene la struttura della cartella per le risorse al fine di mantenere i riferimenti tra le DLL.
Per l'esempio precedente, General.dll e Binary.dll sono memorizzati nella cartella MetaTask anche
se Binaary.dll è memorizzato nella sottocartella DLL.
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See the following video for information on migrating MetaBots with DLLs to Automation 360:

MetaBot migration process overview

Use the information provided in this section to understand the processes involved in migrating MetaBot to
Automation 360.

Concept of DLL session in the migrated bot The following DLL changes are observed in the
migrated bot:
• When you migrate a TaskBot with multiple

MetaBots that contain DLLs with the same
name, a session name using the name of the
first DLL is created. When the subsequent DLL
with the same name from another MetaBot is
migrated, the ID of the folder in which the DLL
resides is used as a session name.
For example:M_DLL_Session-
<MetabotFolderId>_<DLLName>.

• When the Execute DLL command in Enterprise
11 is migrated to Automation 360, the command
is converted to the Open and Run function
actions and the Dll Session does not exist If
condition.

• The DLL session name is created by appending
the DLL name to the "M-DLL-Session-" token.
For example, if the DLL name is Sample.dll, after
migration, the DLL session name will be M-DLL-
Session-Sample.

• The DLL session represents the DLL it is using to
run the DLL functions.

• To run multiple functions from the same DLL,
the same DLL session name must be provided in
the Session name field.

Condition to check for the existence of a DLL
session in a migrated bot

After migration, when the same DLL is used across
multiple logics of the same MetaBot, a condition
to check if a DLL session is already open is added
for every DLL to ensure that the DLL session is
opened only once. Some DLLs that are used in
MetaBot share sessions or global variables across
multiple DLL functions. If such DLL functions are
called from different logics, sharing of such sessions
and variables is possible only if the DLL session
is opened only once and a condition is added to
check if a DLL session is already available. If a DLL
session is missing, Automation 360 creates a DLL
session of type Global.

What happens to a migrated TaskBot that has
reference to two DLL functions from same or
different logics of a MetaBot?

In Enterprise 11, if a TaskBot was referencing to a
logic that called two functions using the Run Logic
command, in Automation 360, a DLL session will
be created in the TaskBot (logics are migrated as
TaskBots) and will be used in the Run function
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action. Also, when a TaskBot refers multiple logics
that calls multiple functions, the TaskBots will
use the same DLL session name to execute the
functions. The DLL session condition check will
ensure that only one session is created across such
logics.
For example, if a TaskBot is using MetaBot1 Logic
and MetaBot2 Logic where MetaBot1 Logic and
MetaBot2 Logic are calling multiple functions, when
you run the Taskbot, a DLL session name is created
to run MetaBot1 Logic. The DLL session name that
was created to run MetaBot1 Logic will be used to
run MetaBot2 Logic as well.

Migrazione delle schermate

Ogni schermata in un MetaBot viene convertita in una variabile Windows e il actions eseguito sullo
schermo viene migrato all'equivalente actions in Automation 360.
La tabella seguente elenca le schermate che è possibile migrare a Automation 360:

Browser Internet Explorer
Google Chrome (solo per il tipo di riproduzione
oggetto)

Tipo di schermata Standard

Tecnologia Java, HTML, MSAA, .Net, UI Automation (solo
per il tipo di riproduzione oggetto)

Tipo di riproduzione Oggetto, immagine, coordinata

Puoi eseguire la migrazione di MetaBots con schermate acquisite nell'ambiente Citrix da applicazioni basate
su Java, UI Automation e MSAA.
Gli oggetti collegati in una schermata MetaBot che vengono acquisiti utilizzando il tipo di riproduzione
oggetto vengono migrati a action Acquisisci di Recorder package. L'oggetto di origine viene visualizzato
nella scheda Principale e l'oggetto collegato viene visualizzato nella scheda Ancoraggio dell'azione
Acquisisci.
La tabella seguente fornisce informazioni sulle azioni eseguite su un oggetto tipo di riproduzione oggetto 
e l'oggetto collegato tipo di riproduzione testo disponibile nella schermata viene migrato alle azioni
equivalenti in Automation 360:
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Tipo di
riproduzione

Enterprise 11 Azione Automation 360 Azione

Oggetto Ottieni proprietà, Ottieni
elementi totali, Ottieni
indice selezionato, Ottieni
testo selezionato, Seleziona
elemento per testo,
Seleziona elemento per
indice, Fai clic, Fai clic con
il tasto sinistro del mouse,
Fai clic con il tasto destro
del mouse, Fai doppio clic,
Imposta testo, Aggiungi
testo, Ottieni proprietà,
Seleziona, Deseleziona,
Toggle, Espandi, Seleziona,
Ottieni stato,

È stata eseguita la migrazione a action Acquisisci
di Recorder package.
I comandi GetAllChidrenName e
GetAllChidrenValue in Enterprise 11/Enterprise
10 restituiscono valori di variabile di tipo stringa.
In Automation 360, restituiscono valori di elenco. Il
processo di migrazione unisce i valori dell'elenco e
li archivia in una variabile di stringa per mantenere
comportamenti bot coerenti tra le versioni.
Il comando Clonazione dell'oggetto con l'azione
Esporta in CSV in Enterprise 11/Enterprise 10
viene migrato in:
• action Acquisisci di Recorder package.

action salva la data acquisita in una variabile
tabella.

• action Scrivi su file di Data Table package.
action vengono salvati dalla variabile della
tabella nel file CSV.

La tabella seguente fornisce informazioni sulle azioni eseguite su un oggetto tipo di riproduzione immagine
oggetto collegato tipo di riproduzione immagine disponibile nella schermata viene migrato alle azioni
equivalenti in Automation 360:

Tipo di
riproduzione

Enterprise 11 Azione Automation 360 Azione

Fai clic con il tasto sinistro È stata eseguita la migrazione a action Trova la
finestra nella finestra di Image Recognition
package con Clic con Clic con il tasto sinistro
selezionato dall'elenco Azione.

Fai clic con il tasto destro È stata eseguita la migrazione a action Trova la
finestra nella finestra di Image Recognition
package con Clic con il tasto destro selezionato
dall'elenco Azione.

Fai doppio clic È stata eseguita la migrazione a action Trova la
finestra nella finestra di Image Recognition
package con Doppio clic selezionato dall'elenco
Azione.

Immagine

Clic centrale È stata eseguita la migrazione a action Trova la
finestra nella finestra di Image Recognition
package con Clic con Clic con il tasto sinistro
selezionato dall'elenco Azione.
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Tipo di
riproduzione

Enterprise 11 Azione Automation 360 Azione

Imposta testo Migrazione a:
• action Trova la finestra nella finestra di

Image Recognition package con Clic con il
tasto sinistro selezionato dall'elenco Azione.

• action Ritardo di Delay package con il ritardo
Regolare impostato su 500 millisecondi.

• action Simula sequenze di tasti di Simulate
keystrokes package.

Ottieni testo È stata eseguita la migrazione a action Acquisisci
area di OCR package.

GetVisibility Migrated to IF action with condition Image
Recognition:Find Window in window. The
GetVisibility action returns a True or False
value based on whether the object in an image is
visible or not. Similarly, the condition within the IF
action is evaluated based on whether the window is
found in another window. The result is stored in a
temporary variable.

La tabella seguente fornisce informazioni sulle azioni eseguite su un oggetto tipo di riproduzione coordinata
l'oggetto collegato tipo di riproduzione coordinata disponibile nella schermata viene migrato alle azioni
equivalenti in Automation 360:

Tipo di
riproduzione

Enterprise 11 Azione Automation 360 Azione

Fai clic È stata eseguita la migrazione a action Clic di
Mouse package con le opzioni Pulsante sinistro e
Clic selezionate.

Fai clic con il tasto sinistro È stata eseguita la migrazione a action Clic di
Mouse package con le opzioni Pulsante sinistro e
Clic selezionate.

Fai clic con il tasto destro È stata eseguita la migrazione a action Clic di
Mouse package con le opzioni Pulsante destro e
Clic selezionate.

Clic centrale È stata eseguita la migrazione a action Clic di
Mouse package con le opzioni Pulsante centrale e
Clic selezionate.

Coordinata

Fai doppio clic È stata eseguita la migrazione a action Clic di
Mouse package con le opzioni Pulsante sinistro e
Doppio clic selezionate.
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Tipo di
riproduzione

Enterprise 11 Azione Automation 360 Azione

Imposta testo Migrazione a:
• action Clic di Mouse package con le opzioni

Pulsante sinistro e Clic selezionate.
• action Ritardo di Delay package con il ritardo

Regolare impostato su 500 millisecondi.
• action Simula sequenze di tasti di Simulate

keystrokes package.

Ottieni testo Migrazione a:
• action Clic di Mouse package con le opzioni

Pulsante sinistro e Clic selezionate.
• action Cancella di Clipboard package.
• action Ritardo di Delay package con il ritardo

Regolare impostato su 500 millisecondi.
• action Simula sequenze di tasti di Simulate

keystrokes package.
• action Ritardo di Delay package con il ritardo

Regolare impostato su 500 millisecondi.
• action Copia in di Clipboard package.

La tabella seguente fornisce informazioni sulle azioni eseguite su un oggetto personalizzato con tipo di
riproduzione Coordinata disponibile sullo schermo che viene migrato ad azioni equivalenti in Automation
360:

Tipo di
riproduzione

Azione Enterprise
11

Azione Automation 360

Fai clic È stata eseguita la migrazione a action Clic di Mouse package
con le opzioni Pulsante sinistro e Clic selezionate.

Fai clic con il tasto
sinistro

È stata eseguita la migrazione a action Clic di Mouse package
con le opzioni Pulsante sinistro e Clic selezionate.

Clic centrale È stata eseguita la migrazione a action Clic di Mouse package
con le opzioni Pulsante centrale e Clic selezionate.

Fai doppio clic È stata eseguita la migrazione a action Clic di Mouse package
con le opzioni Pulsante sinistro e Doppio clic selezionate.

Coordinata

Imposta testo Migrazione eseguita a:
• action Clic di Mouse package con le opzioni Pulsante

sinistro e Clic selezionate.
• action Ritardo di Delay package con il ritardo Regolare

impostato su 500 millisecondi.
• action Simula sequenze di tasti di Simulate keystrokes

package.
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Tipo di
riproduzione

Azione Enterprise
11

Azione Automation 360

Ottieni testo Migrazione eseguita a:
• action Clic di Mouse package con le opzioni Pulsante

sinistro e Clic selezionate.
• action Cancella di Clipboard package.
• action Ritardo di Delay package con il ritardo Regolare

impostato su 500 millisecondi.
• action Simula sequenze di tasti di Simulate keystrokes

package.
• action Ritardo di Delay package con il ritardo Regolare

impostato su 500 millisecondi.
• action Copia in di Clipboard package.

La tabella seguente fornisce informazioni sulle azioni eseguite su un oggetto personalizzato con tipo di
riproduzione Testo disponibile sullo schermo che viene migrato ad azioni equivalenti in Automation 360:

Tipo di
riproduzione

Azione Enterprise
11

Azione Automation 360

Fai clic È stata eseguita la migrazione a action Trova la finestra
nella finestra di Image Recognition package con Clic con il
tasto sinistro selezionato dall’elenco Azione.

Fai clic con il tasto
sinistro

È stata eseguita la migrazione a action Trova la finestra
nella finestra di Image Recognition package con Clic con il
tasto sinistro selezionato dall’elenco Azione.

Fai doppio clic È stata eseguita la migrazione a action Trova la finestra
nella finestra di Image Recognition package con Doppio
clic selezionato dall’elenco Azione.

Imposta testo Migrazione eseguita a:
• action Trova la finestra nella finestra di Image

Recognition package con Clic con tasto sinistro
selezionato dall’elenco Azione.

• action Ritardo di Delay package con il ritardo Regolare
impostato su 500 millisecondi.

• action Simula sequenze di tasti di Simulate keystrokes
package.

Testo

Ottieni testo È stata eseguita la migrazione a action Acquisisci area di
OCR package.

Migrazione della logica

Ogni logica in un MetaBot viene convertita in un TaskBot e ogni comando utilizzato in una logica viene
convertito nell'azione equivalente in Automation 360. La variabile utilizzata in una logica viene convertita
in una variabile equivalente in Automation 360. Le variabili delle credenziali utilizzate nella logica vengono
migrate a Automation 360 e utilizzate nelle azioni equivalenti nei bots migrati. Se il Tipo di parametro di
una variabile è input o output, lo stesso viene mantenuto dopo la migrazione di tale variabile a Automation
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360. Ad esempio, se il Tipo di parametro della variabile ABC è impostato come Input, la variabile
ABC creata in Automation 360 ha l'opzione Usa come input selezionata dopo la migrazione. Il sistema
conserva la struttura interna delle cartelle delle logiche. Per l'esempio precedente, tutte le logiche migrate
vengono archiviate come elencato nella tabella seguente:

Struttura delle cartelle in Automation 360 Voce

MetaTask Comune

MetaTask\Process1 Connetti

MetaTask\Process1 Disconnetti

MetaTask\Process1\Operations Numerico

La tabella seguente fornisce informazioni su come il comando Import DataSet utilizzato nella logica
MetaBot viene migrato ad azioni equivalenti in Automation 360:

Tipo di
riproduzione

Enterprise 11 Azione Automation 360 Azione

Oggetto Ottieni proprietà, Ottieni
elementi totali, Ottieni
indice selezionato, Ottieni
testo selezionato, Seleziona
elemento per testo,
Seleziona elemento per
indice, Fai clic, Fai clic
con il pulsante sinistro
del mouse, Fai clic con il
pulsante destro del mouse,
Fai doppio clic

È stata eseguita la migrazione a action Acquisisci
di Recorder package.

Fai clic con il tasto sinistro È stata eseguita la migrazione a action Trova la
finestra nella finestra di Image Recognition
package con Clic con Clic con il tasto sinistro
selezionato dall'elenco Azione.

Fai clic con il tasto destro È stata eseguita la migrazione a action Trova la
finestra nella finestra di Image Recognition
package con Clic con il tasto destro selezionato
dall'elenco Azione.

Fai doppio clic È stata eseguita la migrazione a action Trova la
finestra nella finestra di Image Recognition
package con Doppio clic selezionato dall'elenco
Azione.

Immagine

Clic centrale È stata eseguita la migrazione a action Trova la
finestra nella finestra di Image Recognition
package con Clic con Clic con il tasto sinistro
selezionato dall'elenco Azione.
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Tipo di
riproduzione

Enterprise 11 Azione Automation 360 Azione

Imposta testo Migrazione a:
• action Trova la finestra nella finestra di

Image Recognition package con Clic con il
tasto sinistro selezionato dall'elenco Azione.

• action Ritardo di Delay package con il ritardo
Regolare impostato su 500 millisecondi.

• action Simula sequenze di tasti di Simulate
keystrokes package.

Fai clic È stata eseguita la migrazione a action Clic di
Mouse package con le opzioni Pulsante sinistro e
Clic selezionate.

Fai clic con il tasto sinistro È stata eseguita la migrazione a action Clic di
Mouse package con le opzioni Pulsante sinistro e
Clic selezionate.

Clic centrale È stata eseguita la migrazione a action Clic di
Mouse package con le opzioni Pulsante centrale
e Clic selezionate.

Fai doppio clic È stata eseguita la migrazione a action Clic di
Mouse package con le opzioni Pulsante sinistro e
Doppio clic selezionate.

Coordinata

Imposta testo Migrazione a:
• action Clic di Mouse package con le opzioni

Pulsante sinistro e Clic selezionate.
• action Ritardo di Delay package con il ritardo

Regolare impostato su 500 millisecondi.
• action Simula sequenze di tasti di Simulate

keystrokes package.

La tabella seguente fornisce informazioni su come il comando Export Dataset utilizzato nella logica MetaBot
viene migrato ad azioni equivalenti in Automation 360:

Tipo di
riproduzione

Enterprise 11 Azione Automation 360 Azione

Oggetto Ottieni proprietà, Ottieni
elementi totali, Ottieni
indice selezionato, Ottieni
testo selezionato, Seleziona
elemento per testo,
Seleziona elemento per
indice, Fai clic, Fai clic
con il pulsante sinistro
del mouse, Fai clic con il
pulsante destro del mouse,
Fai doppio clic

È stata eseguita la migrazione a action Acquisisci
di Recorder package.
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Tipo di
riproduzione

Enterprise 11 Azione Automation 360 Azione

Fai clic con il tasto sinistro È stata eseguita la migrazione a action Trova la
finestra nella finestra di Image Recognition
package con Clic con Clic con il tasto sinistro
selezionato dall'elenco Azione.

Fai clic con il tasto destro È stata eseguita la migrazione a action Trova la
finestra nella finestra di Image Recognition
package con Clic con il tasto destro selezionato
dall'elenco Azione.

Fai doppio clic È stata eseguita la migrazione a action Trova la
finestra nella finestra di Image Recognition
package con Doppio clic selezionato dall'elenco
Azione.

Clic centrale È stata eseguita la migrazione a action Trova la
finestra nella finestra di Image Recognition
package con Clic con Clic con il tasto sinistro
selezionato dall'elenco Azione.

Immagine

Ottieni testo È stata eseguita la migrazione a action Acquisisci
area di OCR package.

Fai clic È stata eseguita la migrazione a action Clic di
Mouse package con le opzioni Pulsante sinistro e
Clic selezionate.

Fai clic con il tasto sinistro È stata eseguita la migrazione a action Clic di
Mouse package con le opzioni Pulsante sinistro e
Clic selezionate.

Clic centrale È stata eseguita la migrazione a action Clic di
Mouse package con le opzioni Pulsante centrale
e Clic selezionate.

Fai doppio clic È stata eseguita la migrazione a action Clic di
Mouse package con le opzioni Pulsante sinistro e
Doppio clic selezionate.

Coordinata

Ottieni testo Migrazione a:
• action Clic di Mouse package con le opzioni

Pulsante sinistro e Clic selezionate.
• action Cancella di Clipboard package.
• action Ritardo di Delay package con il ritardo

Regolare impostato su 500 millisecondi.
• action Simula sequenze di tasti di Simulate

keystrokes package.
• action Ritardo di Delay package con il ritardo

Regolare impostato su 500 millisecondi.
• action Copia in di Clipboard package.
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Migrazione del comando Esecuzione logica

Il comando Esegui logica viene utilizzato in un bot per eseguire una logica specifica da un MetaBot
in Enterprise 11. Quando esegui la migrazione di tale bot, il comando Esegui logica viene convertito
nell'azione Esegui di Task Bot package.
Le variabili di input vengono convertite in variabili equivalenti in Automation 360 e le variabili di output
vengono migrate in una variabile di dizionario. Puoi utilizzare la chiave nella variabile del dizionario per
utilizzare il valore associato. La variabile del dizionario potrebbe contenere altri tipi di variabile, ad esempio
elenco, valore, numero intero e matrice. È possibile mappare le variabili disponibili nella variabile del
dizionario con altri tipi di variabili. Ad esempio, è possibile mappare la variabile di tipo elenco disponibile
nella variabile del dizionario con le variabili di elenco, valore e tipo di matrice.

Migrazione del comando Esegui

Le DLL in MetaBots utilizzano il comando Esegui per eseguire una funzione da tale DLL. Dopo la
migrazione a Automation 360, ogni comando Esegui viene convertito nelle azioni Apri, Esegui funzione
e Chiudi del pacchetto DLL. Informazioni su quale funzione eseguire dalla DLL, quali parametri utilizzare e
altri dettagli nel comando Esegui vengono migrati all'azione Esegui.
A partire da Enterprise A2019.16 (6448), puoi migrare MetaBots che contiene le DLL i cui tipi di
restituzione sono diversi da quelli di MetaBot. La tabella seguente fornisce informazioni sul tipo di variabile
dell'output di MetaBot e sul tipo di restituzione di una DLL.

Tipo di variabile MetaBot Tipo di ritorno funzione DLL

Valore Matrice bidimensionale, Elenco, Byte in matrice
(Byte[]), numeri interi non firmati (UInt32,
UInt64), numeri interi firmati, IDictionary, IList
e numeri interi non firmati in matrice (UInt16[],
UInt32[], UInt64[]), byte firmato

Array Matrice bidimensionale, elenco, numeri interi non
firmati (UInt16[], UInt32, UInt64), numeri interi
firmati, IList, byte firmato e IDictionary

Note:  La migrazione di bots che utilizza la variabile IDictionay è supportata, tuttavia, la migrazione di bots
potrebbe non restituire il valore corretto. Questo comportamento è lo stesso in Enterprise 11 o Enterprise
10.

La tabella seguente fornisce informazioni sul tipo di variabile che viene passato da MetaBot e il tipo di input
che una DLL accetta.

Tipo di variabile di MetaBot Tipo di variabile di input accettata dalla DLL

Elenco Matrice bidimensionale, Elenco, byte, numeri
interi non firmati (UInt16, UInt32, UInt64),
numeri interi firmati, byte firmato, byte in
matrice (Byte[]) e numeri interi non firmati in
matrice (UInt16[], UInt32[], UInt64[])

Array Matrice bidimensionale, Elenco, byte, numeri
interi non firmati (UInt16, UInt32, UInt64),
numeri interi firmati, byte firmato, byte in
matrice (Byte[]) e numeri interi non firmati in
matrice (UInt16[], UInt32[], UInt64[])
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Tipo di variabile di MetaBot Tipo di variabile di input accettata dalla DLL

Valore Byte, numeri interi non firmati (UInt16, UInt32,
UInt64), numeri interi firmati, byte firmato

Dizionario Byte, numeri interi non firmati (UInt16, UInt32,
UInt64), numeri interi firmati, byte firmato

Come viene migrata la variabile AAApplicationPath
La variabile AAApplicationPath viene utilizzata in Enterprise 11 e Enterprise 10 per specificare il percorso
fisico di bot o file impiegati nel bot corrente. La variabile di sistema AAApplicationPath restituisce il
percorso impostato in Strumento > Opzione di quella che è nota come “applicazione client”.

Migrazione da Enterprise 11 tramite un database di Enterprise 11 ripristinato

Quando esegui la migrazione a Automation 360 utilizzando un database di Enterprise 11 ripristinato, il
processo di migrazione completa le seguenti operazioni:
• Crea il valore globale AAApplicationPath al momento della migrazione del primo bot tramite Bot

Migration Wizard.
• Copia il valore della variabile di sistema AAApplicationPath specificata per ciascun utente in Enterprise

11 e imposta tale valore sul valore globale AAApplicationPath per tutti questi utenti in Automation 360.
• Aggiorna i riferimenti utilizzati nei bots Enterprise 11 con il valore globale AAApplicationPath

disponibile nella Control Room di Automation 360, eliminando qualsiasi requisito di aggiornamento per
l'utilizzo di AAApplicationPath da parte dei bots migrati.

• Aggiorna il percorso nel set di comandi Esegui attività nel bot Enterprise 11. Per esempio, se il
percorso nel comando Esegui attività è impostato su $AAApplicationPath$\Automation
 Anywhere\My Tasks\child-task.atmx in Enterprise 11, questo percorso viene automaticamente
convertito in Bots\My Tasks\child-task.atmx dopo la migrazione.
Pertanto, non è richiesto alcun aggiornamento manuale e il bot viene eseguito così com'è dopo la
migrazione.

Important:  Quando esegui la migrazione di bots tramite Bot Migration package, devi creare
manualmente il valore globale AAApplicationPath. Al termine della creazione di tale valore globale, tutti gli
utenti che hanno utilizzato la variabile di sistema AAApplicationPath in Enterprise 11 devono aggiornare il
valore globale AAApplicationPath con il valore utilizzato in Enterprise 11.
Per informazioni, consulta Migrazione da Enterprise 11 tramite un database di Enterprise 11 ripristinato.

Migrazione da Enterprise 10

Quando esegui la migrazione da Enterprise 10, devi creare manualmente il valore globale
AAApplicationPath in Automation 360 con l'opzione È POSSIBILE effettuare la modifica selezionata.
Al termine della creazione di tale valore globale, tutti gli utenti che hanno utilizzato la variabile di sistema
AAApplicationPath in Enterprise 10 devono aggiornare il valore globale AAApplicationPath con il valore
utilizzato in Enterprise 10. Questo aggiornamento garantisce che quando esegui bot in Automation 360, il
valore della cartella AAApplicationPath sia risolto in modo univoco per ogni utente.
Esempio: Se il valore del percorso Enterprise 10 per AAApplicationPath è D:\John.Doe
\My Documents\Automation Anywhere Files, è necessario creare il valore globale
AAApplicationPath in Automation 360 e aggiornarlo con questo percorso.
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Note:  Bot Runners e Bot Creators devono aggiornare il valore globale per AAApplicationPath nella
Control Room prima di poter eseguire i bots migrati in Automation 360.

Consulta Preparazione per la migrazione Enterprise 10 a Automation 360 On-Premises on page 1203.

Migrazione manuale da Enterprise 11 o Enterprise 10

Quando esegui la migrazione manuale da Enterprise 11 o Enterprise 10, devi creare manualmente il
valore globale AAApplicationPath in Automation 360 con l'opzione È POSSIBILE effettuare la modifica
selezionata. Al termine della creazione di tale valore globale, tutti gli utenti che hanno utilizzato la
variabile di sistema AAApplicationPath in Enterprise 11 o Enterprise 10 devono aggiornare il valore globale
AAApplicationPath con il valore utilizzato in Enterprise 11 o Enterprise 10.
Consulta Prerequisiti per la migrazione manuale on page 1188.

AASettings supported in Automation 360
Review the configurations supported in the AASettings file for the Control Room.
After migration, you can configure the AASettings that are supported in Automation 360.
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Chiave Descrizione Values allowed Valore predefinito Supported in
Automation 360

allowaddingdefaultnamespaceAllows you
to enable
DefaultNSPrefix.
In the XML
package, when
you insert a node
into the XML file,
DefaultNSPrefix is
no longer added.
In the Advanced
view tab of the
insert a node
action, xmlns
(the default XML
namespace) is not
allowed either as
a prefix or as an
attribute.

Note:  If
DefaultNSPrefix
is enabled and
the value of
allowaddingdefaultnamespace
is set to True,
when you insert
or update a new
node as an empty
node, a newline
character will
be added and
indentation will be
lost.

True, False Falso No

allowlowersecurityciphersslconnectionformainframeAllows you
to lower the
security cipher
for connecting
to mainframe
hosts that use SSL
connections with
lower security
cipher.

True, False Falso No

applyshiftkeyfix Allows you to
check for any
missing special
key in child bots
and executes the
key if the special
key is missing.

0, 1 0 No

© 2023 Automation Anywhere. All rights reserved.     1237



    Automation Anywhere - Migrazione a Automation 360

Chiave Descrizione Values allowed Valore predefinito Supported in
Automation 360

capturehtmlwithjs Allows you to
enable capturing
HTML by MetaBot
screen capture.

True, False Vero No

citrixchanneltimeoutAllows you to set
the Citrix channel
timeout value for
the Citrix remote
agent.

Integer -- No

closebrowserbyhandleAllows you
to enable
CloseIEInstanceByhandle
if
CloseIEInstanceByprocess
fails.

0, 1 0 No

connectionretryattemptsAllows you
to configure
the number of
attempts to try
for connecting to
the mainframe if
connection to the
mainframe failed.

Integer 3 No

connectionretryintervalAllows you to
configure the
timeout value,
in milliseconds,
to wait before
attempting the
next connection.

Integer 3000 No

connectiontimeout Allows you to
configure the
timeout value,
in minutes,
for database
connections. We
recommend that
you configure this
timeout value to
30 minutes.

Integer 30 No

CustomDateFormat Allows you to set
a custom date
format.

String (mm/dd/
yyyy HH:mm:ss)

-- No

DecimalPlaces Allows you to
configure the
number of decimal
places for digits
used in the
Number element.

Integer from 0 to
16

4 No
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Chiave Descrizione Values allowed Valore predefinito Supported in
Automation 360

enablesetfocusapi Allows you
to configure
the SetFocus
API for Oracle
applications.

True, False Falso No

fetchemailretrycountAllows you to
configure the
number of retries
for fetching
emails.

Integer 3 No

findiewndattmpt Allows you to
use the MetaBot
recorder to search
for objects.

Integer 5 No

ietimeoutvalue Allows you to
configure the
timeout value for
capturing MetaBot
screens.

Integer 240 No

IETimeoutValue Allows you to
configure the
maximum timeout
value, in seconds,
for loading a
webpage on
Internet Explorer.

Integer 240 No

IsEnabled Allows you to
check whether
the decimal places
option in the
Number element
is enabled or
disabled.

True, False Falso No

isremoteobjectdetectionenabledAllows you to
enable automation
of Citrix XenApp
through the
Enterprise Client.

True, False Falso No

iterationtoverify  Allows you to
configure the
number of retries
to verify a value in
a cell.

Integer 3 No

keystrokedelay Allows you to
configure a delay
between the up
and down keys in
an Excel table.

Integer 25 No
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Chiave Descrizione Values allowed Valore predefinito Supported in
Automation 360

legacybehaviourforcommaAllows you to
retain the legacy
behavior for the
comma sign.

True, False Vero No

multithreadlogic Allows you to
enable or disable
multithreading.

0, 1 1 No

NormalizationForm Allows you
to verify
whether string
normalization is
available.

NFC, NFD, NFKC,
NFKD

-- No

ParallelThreadCountAllows you to
configure the
number of links
that can be
processed at a
time.

Integer 10 No

perchardelay Allows you to
configure the
delay between
entering two
characters as
input.

Integer 0 No

percommanddelay Allows you to
configure the
delay between
running keystroke
commands.

Integer 0 No

readvirtualproperty Allows you
to enable the
GetvirtualAccessibleName
API.

True, False Vero No

readwithsystemencodingAllows you to
configure the
default encoding
for the system.

True, False Vero No

restclienttype Allows you to
execute REST
Web Service.

restsharpclient,
nativerestclient

restsharpclient No

retainexcelcellrowlegacybehaviorAllows you
to revert the
behavior of
ExcelCellRow to
Enterprise 11
version 11.3.1 or
earlier.

True, False Falso No
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Chiave Descrizione Values allowed Valore predefinito Supported in
Automation 360

screenchangewaittimeAllows you to
configure the
timeout value,
in milliseconds,
to wait for the
application after
sending certain
keys because
the screen might
change after
sending some
keys.

Integer 5 No

searchinmultiplewindowAllows you to
check for windows
with the same
name.

0, 1 0 No

ShutDownTimeout Allows you to
configure the
timeout value for
the Shutdown
action in the
System package.

Integer 30000 No

skipappnames Allows you to
check whether
the application is
Oracle.

Comma-separated
application
starting name.
For example, if
the application
window
title is Test
Application,
then it should
contain the
following value:
Test,abc,xyz

-- No

textplayirpercentageAllows you to
configure the
match percentage
of the image
recognition based
control finding
in the legacy
AISense Recorder.

Integer from 0 to
100

95 No

timeout Allows you to
configure the
HTTP request
timeout value for
the REST Web
Service command.

Stringa 60000 No
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Chiave Descrizione Values allowed Valore predefinito Supported in
Automation 360

Timeout Allows you to
configure the
timeout value
for each web
response while
traversing through
webpages.

Integer 10 No

usesinglethreading Allows you to
enable or disable
single threading.

True, False Vero No

versione Allows you to
select multiple
versions of
keystroke
commands in
Enterprise 11.

Integer 1 No

WaitForPageLoad Allows you
to configure
additional delay
for loading
webpages in
MetaBot and
Recorder.

0, 1 0 No

WaitForWindow Allows you to
configure the wait
time for window.

Integer 30 No

WaitForWindowCheckAllows you to
check whether
the wait time
for window is
enabled.

0, 1 0 No

windowactivationmodeAllows you to
activate Window
using a None key.

0, 1, 2 0 No

windowresize Allows you to
disable the
resizing of window
during execution.

True, False Vero No

Abilita le pianificazioni dopo la migrazione
Quando copi i dati Enterprise 10 in Automation 360, le pianificazioni Enterprise 10 vengono migrate.
Le pianificazioni Enterprise 11 delle versioni vengono migrate quando aggiorni i dati Enterprise 11 in
Automation 360.
Dopo la migrazione di un bot associato a una pianificazione, il sistema sostituisce automaticamente
il file .atmx bot all'interno di tale pianificazione con Automation 360 bot. Le pianificazioni migrate
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sono inattive e non hanno dispositivi associati, pertanto alcune dipendenze devono essere rimappate
nell'ambiente Automation 360.
Per riabilitare le pianificazioni migrate, attenersi alla seguente procedura:
1. Verifica che la migrazione del collegamento bot alla pianificazione sia stata eseguita correttamente.

Le pianificazioni migrate puntano solo a bots migrati correttamente. Se una migrazione bot non riesce,
la pianificazione associata continua a puntare a .atmx bot.

2. Installa Bot Agent sui dispositivi Bot Runner.
Installazione di Bot Agent e registrazione del dispositivo on page 1039

3. Modifica la pianificazione per aggiungere i dispositivi pertinenti.
Programmare un bot on page 2616

4. Attiva la pianificazione facendo clic su Abilita dopo aver fornito le informazioni necessarie per la
pianificazione di un bot.
Programmare un bot on page 2616

Related concepts
Migrazione a Automation 360 on page 1126
Related tasks
Copia dati Enterprise 10 on page 1207
È necessario copiare i dati Enterprise 10 in Automation 360 prima di convertire Enterprise 10 bots.
Copiare e incollare le informazioni di Enterprise 11 in Automation 360 on page 1191
I file dell'archivio del server Enterprise 11 e il file Credential Vault sono richiesti nell'ambiente Automation
360. Il modo più efficiente per ottenere questi dati è copiarli dall'ambiente Enterprise 11 in Automation
360.
Migrazione dei bots di Enterprise on page 1216
The bot migration process uses the Bot Migration Wizard to convert Enterprise 11 or Enterprise 10 bots
(TaskBots and MetaBots) in .atmx and .mbot format to the .bot format used in Automation 360 and
uploads the successfully migrated bots to the Control Room public workspace.

Sospendere e riprendere la migrazione dei bot
È possibile mettere in pausa e riprendere la migrazione dei bot sospesa. Se si desidera eseguire
un'operazione ad alta priorità sullo stesso dispositivo Bot Runner su cui è in esecuzione la migrazione dei
bot, potrebbe essere necessario sospendere la migrazione dei bot.
È necessario disporre delle autorizzazioni necessarie per avviare la migrazione dei bot.
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• Metti in pausa e riprendi la migrazione dei bot quando viene utilizzato un solo Bot Runner per la
conversione dei bot:
a) Seleziona la migrazione dei bot attiva che si desidera sospendere dalla pagina Attività > In

corso.
b) Fai clic sull'icona di pausa nella utilità di avvio dei bot o nella pagina In corso.

Il sistema sospende la migrazione dei bot. Lo stato della migrazione dei bot è elencato nei seguenti
campi:
• Pagina Attività > In corso e contrassegnata come in pausa.
• Migrazione dei bot nella pagina Amministrazione > Migrazioni, in cui lo stato viene

visualizzato come in pausa.
• Nella scheda Report di migrazione bot, in cui lo stato del bot che è stato convertito e il

processo di migrazione del bot sospeso sono impostati come in pausa. Lo stato di tutti gli altri
bots che non sono stati convertiti è impostato come in sospeso.

c) Seleziona la migrazione dei bot in pausa che si desidera riprendere dalla pagina Attività > In
corso.

d) Fai clic sull'icona di riavvio nella procedura di avvio dei bot o nella pagina In corso.
Il sistema riprende i processi di migrazione dei bot in pausa. Lo stato dettagliato della migrazione di
bot ripresa è disponibile nei seguenti campi:
• Pagina Attività > In corso in cui lo stato è contrassegnato come attivo.
• Pagina Amministrazione > Migrazioni in cui lo stato è contrassegnato come in corso.
• Nella scheda Report di migrazione bot, in cui lo stato del bot che è stato convertito e il

processo di migrazione del bot, sospeso sono impostati come in corso.

• Sospendi e riprendi la migrazione di bot su alcuni Bot Runners quando per la conversione dei bot
vengono utilizzati più Bot Runners:
a) Seleziona la migrazione dei bot attiva che si desidera sospendere dalla pagina Attività > In

corso.
b) Fai clic sull'icona di pausa sulla barra degli strumenti per mettere in pausa i processi di migrazione

selezionati.
Il sistema mette in pausa i processi di migrazione selezionati in esecuzione su vari Bot Runners.
Lo stato della migrazione di bot messa in pausa è visualizzato nella pagina Attività > In corso e
contrassegnato come in pausa.
Non vi è alcuna modifica nello stato del processo di migrazione dei bot nella pagina
Amministrazione > Migrazioni e nella scheda Report di migrazione bot.

c) Seleziona le migrazioni di bot in pausa che si desidera riprendere dalla pagina Attività > In corso.
d) Fai clic sull'icona di riavvio sulla barra degli strumenti per riprendere il processo di migrazione di bot

in pausa.
Il sistema riprende la migrazione dei bot per il Bot Runners selezionato. Lo stato dei Bot Runners
per i quali la migrazione di bot viene ripresa viene visualizzato nella pagina Attività > In corso e
contrassegnato come attivo.
Lo stato del processo di migrazione di bot nella pagina Amministrazione > Migrazioni è
visualizzato come in corso.
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• Metti in pausa un processo di migrazione di bot su tutti i Bot Runners quando vengono utilizzati più Bot
Runners per la conversione dei bot.
a) Seleziona tutta la migrazione di bot attiva che si desidera sospendere dalla pagina Attività > In

corso.
b) Fai clic sull'icona di pausa sulla barra degli strumenti per mettere in pausa i processi di migrazione

di bot selezionati.
Il sistema mette in pausa i processi di migrazione di bot selezionati in esecuzione su vari Bot
Runners. La voce per tutti i processi di migrazione in pausa è disponibile su:
• Pagina Attività > In corso e contrassegnata come in pausa.
• Pagina Amministrazione > Migrazioni visualizzata come in pausa.
• Scheda Report di migrazione bot, in cui lo stato del bots per cui la migrazione non è stata

avviata viene impostato come in pausa.

c) Seleziona tutte le migrazioni di bot in pausa che si desidera riprendere dalla pagina Attività > In
corso.

d) Fai clic sull'icona di riavvio nella procedura di avvio dei bot o nella pagina In corso per tutti i Bot
Runners.
Il sistema riprende i processi di Il migrazione dei bot in pausa. Lo stato per tutti i Bot Runners è
disponibile nei seguenti campi:
• Pagina Attività > In corso e contrassegnata come attiva.
• Pagina Amministrazione > Migrazioni visualizzata come in corso.
• Nella scheda Report di migrazione bot, in cui lo stato del bot che è stato convertito e il

processo di migrazione del bot, sospeso sono impostati come in corso.

Interrompi la migrazione bot
Puoi interrompere una migrazione bot in corso se tale migrazione bot non sta avanzando o non risponde.
È necessario disporre delle autorizzazioni necessarie per avviare la migrazione dei bot.
1. Seleziona la migrazione dei bot attiva che desideri interrompere dalla pagina Attività > In corso.
2. Fai clic sull'icona di interruzione nella procedura di avvio dei bot o nella pagina In corso.

Il sistema termina immediatamente la migrazione del bot. Lo stato della migrazione interrotta dei bot è
elencato nei seguenti campi:
• Pagina Attività > Cronologia e contrassegnata come attiva.
• Pagina Amministrazione > Migrazioni visualizzata come non riuscita.
• Nella scheda Report di migrazione bot, in cui lo stato del bot che è stato convertito e il processo

di migrazione sospeso sono impostati come in pausa. Lo stato di tutti gli altri bots che non sono
stati convertiti è impostato come in sospeso.

• La pagina Visualizza cronologia attività per la voce mostra il motivo dell'errore.

Convalida e aggiornamento dopo la migrazione dei bots
La migrazione dei bots viene caricata nell'archivio pubblico di Automation 360 Control Room (nella stessa
cartella contenente i file .atmx equivalenti). Puoi esaminare lo stato corrente dei bots migrati ed eventuali
errori riscontrati a causa di comandi o attributi non supportati disponibili in quei bots dalla pagina Elenco
di migrazione.
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È importante esaminare, testare e verificare tutti i bots migrati per assicurarsi che vengano eseguiti
correttamente nell'ambiente Automation 360.
Migration Assistant è ora unito a Error Assistant per fornire una visione completa di tutte le righe di un bot
che richiedono una revisione o un'azione da parte dell'utente, oppure che contengono errori che devono
essere risolti. Questa funzionalità è utile per identificare rapidamente le aree dei bots che richiedono
attenzione. Prima di eseguire il test del bot, scorrere l'intero bot migrato dalla prima all'ultima riga in modo
che Migration Assistant contrassegni eventuali problemi.
Se non esamini l'intero bot, puoi visualizzare l'errore compilazione non riuscita.

Aggiornamento di bots

Se un bot richiede modifiche in base ai report di migrazione o alla fase di test, è possibile modificare il bot:
1. Esegui l'estrazione del bot dall'archivio pubblico in un archivio privato.
2. Utilizza Migration Assistant per visualizzare le modifiche apportate ai bots migrati.

Migration Assistant ti guida attraverso le eventuali modifiche richieste e ti offre l'opportunità di
utilizzare al meglio le nuove funzionalità Automation 360.

3. Se necessario, modifica il bot in Bot editor.
Puoi eseguire bot direttamente da Bot editor mentre modifichi il bot e testi le fasi del processo.

Esegui questi passaggi nell'ambiente di sviluppo (DEV). Dopo che la migrazione dei bots ha cancellato i
criteri di validazione preimpostati, spostali nell'ambiente UAT (User Acceptance Testing, test di gradimento
degli utenti) per testare i bots rispetto a sistemi di produzione con set di dati più grandi.
Puoi distribuire il bot in un ambiente di produzione (PROD) solo quando i requisiti UAT sono cancellati.
Questo processo fa parte delle procedure consigliate standard del settore del ciclo di vita dello sviluppo
software (SDLC).

Spostamento dei bots utilizzando Bot Lifecycle Management

Utilizza Bot Lifecycle Management per spostare i bots da un ambiente all'altro. Dopo aver testato ed
eseguito correttamente i bots migrati nell'ambiente di sviluppo (DEV), puoi utilizzare Bot Lifecycle
Management per spostare i bots dall'ambiente DEV all'ambiente UAT. Allo stesso modo, puoi utilizzare Bot
Lifecycle Management per spostare i bots dall'ambiente di produzione (PROD) UAT.
Quando sposti i bots, se si verifica l'errore "Impossibile creare la directory: <directory
name>", consulta Unable to import or export the bots from v11 to Automation 360 (A-People login required).

Versione di compatibilità di Bot

Dopo la migrazione, se rimuovi AAApplicationPath dal percorso di destinazione e la versione di
compatibilità del bot è impostata su 1, la distribuzione del bot non riesce. Ciò accade poiché, nella versione
1, il percorso file viene analizzato in fase di compilazione. A seconda del dispositivo di Control Room (Linux
o Windows), i percorsi dei file o delle cartelle potrebbero differire, generando un errore quando il percorso
viene analizzato durante la compilazione del bot.

Recommendation:  Cambia la versione di compatibilità del bot con 2. In questa versione, il percorso file
viene analizzato in fase di esecuzione del bot, a seconda del dispositivo su cui viene eseguito il bot.

See the following video on how to validate changes made to migrated bots:
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Related reference
Mappatura dei pacchetti per la migrazione on page 1247
Questa pagina contiene informazioni sui comandi Enterprise 10 e Enterprise 11, e su come vengono
mappati alle rispettive azioni o pacchetti Automation 360. In alcuni casi, un comando Enterprise 10
o Enterprise 11 esegue la migrazione in più di un'azione Automation 360. Ciò serve a garantire che il
comportamento del bot migrato sia invariato.
Mappatura delle variabili per la migrazione on page 1279
Nella migrazione, alcune variabili si mappano direttamente dalle versioni precedenti del prodotto a
Automation 360 mentre altre si comportano in modo diverso o contengono modifiche di configurazione.

Mappatura dei pacchetti per la migrazione
Questa pagina contiene informazioni sui comandi Enterprise 10 e Enterprise 11, e su come vengono
mappati alle rispettive azioni o pacchetti Automation 360. In alcuni casi, un comando Enterprise 10
o Enterprise 11 esegue la migrazione in più di un'azione Automation 360. Ciò serve a garantire che il
comportamento del bot migrato sia invariato.

Automation 360 dispone di un nuovo pacchetto denominato Automazione legacy. Il pacchetto fornisce il
supporto aggiuntivo necessario durante la migrazione. The Legacy automation package is for use during
migration only; we do not recommend using this package for new bot development. Legacy Automation
package on page 1668
Puoi migrare i bots quando l'utente che la effettua utilizza un server proxy autenticato.

Note:  Per un elenco di packages e actions che supportano la migrazione e la conversione di bots Internet
Explorer da Enterprise 11 o Enterprise 10 in Automation 360 con Edge con modalità IE, consulta
Pacchetti e azioni.

Active Directory

I rispettivi comandi Active Directory sono migrati all'interno delle azioni Connetti e Disconnetti. Ogni
comando viene migrato come segue:

Comandi Enterprise 11 o Enterprise 10 actions e packages Automation
360 equivalenti

Crea utente Crea utente

Comando Modifica gruppo con l'opzione Rinomina gruppo
selezionata

Rinomina gruppo

Comando Modifica gruppo con l'opzione Elimina gruppo
selezionata

Elimina gruppo

Comando Modifica gruppo con l'opzione Aggiungi utenti al
gruppo selezionata

Aggiungi utenti al gruppo

Comando Modifica gruppo con l'opzione Rimuovi utenti
dal gruppo selezionata

Rimuovi utenti dal gruppo

Comando Modifica gruppo con l'opzione Imposta
proprietà selezionata

Imposta proprietà gruppo

Comando Modifica gruppo con l'opzione Disabilita account
utente selezionata

Disabilita account utente
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Comandi Enterprise 11 o Enterprise 10 actions e packages Automation
360 equivalenti

Comando Modifica gruppo con l'opzione Aggiorna dettagli
utente selezionata

Aggiorna dettagli utente

Comando Modifica utente con l'opzione Rinomina utente
selezionata

Rinomina utente

Comando Modifica utente con l'opzione Elimina utente
selezionata

Elimina utente

Comando Modifica utente con l'opzione Abilita account
utente selezionata

Abilita account utente

Comando Modifica utente con l'opzione Aggiorna opzioni
account selezionata

Aggiorna opzioni account

Comando Modifica utente con l'opzione Modifica password
selezionata

Modifica password

Comando Crea oggetto con l'opzione Oggetto computer
selezionata

Oggetto computer

Comando Crea oggetto con l'opzione Oggetto unità
organizzativa selezionata

Crea unità organizzativa

Comando Cerca con l'opzione Esegui query selezionata Esegui query

Comando Cerca con l'opzione Recupera tutti gli utenti di
un gruppo selezionata

Recupera tutti gli utenti di un
gruppo

Comando Ottieni proprietà con l'opzione Utente selezionata Ottieni proprietà utente

Comando Ottieni proprietà con l'opzione Gruppo
selezionata

Ottieni proprietà gruppo

Comando Ottieni proprietà con l'opzione Computer
selezionata

Ottieni proprietà computer

Comando Ottieni proprietà con l'opzione Unità
organizzativa selezionata

Ottieni proprietà unità
organizzativa

Comando Modifica oggetto con il tipo di oggetto Computer
e l'opzione Rinomina oggetto selezionata

Rinomina computer

Comando Modifica oggetto con il tipo di oggetto Computer
e l'opzione Elimina oggetto selezionata

Elimina computer

Comando Modifica oggetto con il tipo di oggetto Computer
e l'opzione Sposta oggetto selezionata

Sposta computer

Comando Modifica oggetto con il tipo di oggetto Computer
e l'opzione Imposta proprietà selezionata

Imposta proprietà computer

Comando Modifica oggetto con l'oggetto Unità
organizzativa e l'opzione Rinomina oggetto selezionata

Rinomina unità organizzativa

Comando Modifica oggetto con l'oggetto Unità
organizzativa e l'opzione Elimina oggetto selezionata

Elimina unità organizzativa

Comando Modifica oggetto con l'oggetto Unità
organizzativa e l'opzione Sposta oggetto selezionata

Sposta unità organizzativa
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Comandi Enterprise 11 o Enterprise 10 actions e packages Automation
360 equivalenti

Comando Modifica oggetto con l'oggetto Unità
organizzativa e l'opzione Imposta proprietà selezionata

Imposta proprietà unità
organizzativa

Consulta Active Directory package on page 1378.

Integrazione app
Integrazione app in Automation 360 non dispone di azioni per ogni tecnologia, a differenza di Enterprise
10/Enterprise 11. In Automation 360, tutte le operazioni sono divise in singole operazioni.

Comandi Enterprise 11 o Enterprise 10 actions e packages Automation 360
equivalenti

Comandi Integrazione app che acquisiscono il
testo da una finestra

action Acquisisci testo dalla finestra del
package App Integration

Comando Modifica gruppo con l'opzione
Rinomina gruppo selezionata

Rinomina gruppo

Comando Modifica gruppo con l'opzione
Elimina gruppo selezionata

Elimina gruppo

Comando Modifica gruppo con l'opzione
Aggiungi utenti al gruppo selezionata

Aggiungi utenti al gruppo

I bots Enterprise 11 che ridimensionano la finestra dell'applicazione al momento della distribuzione
possono essere migrati a Automation 360.
Consulta App Integration package on page 1398.

Appunti

Tutti i comandi di Appunti sono migrati alle azioni equivalenti del pacchetto Automation 360 Appunti. Non
vi è alcun cambiamento nel comportamento o nel nome dei comandi.
Consulta Clipboard package on page 1435.

Commento

Comment viene migrato all'azione Commento di Automation 360.
Se il comando Comment contiene una variabile o un simbolo $, il comando viene disabilitato dopo la
migrazione.

Database

Enterprise 10/Enterprise 11 utilizza i driver ODBC, mentre Automation 360 usa i driver JDBC.
L'azione Query SQL è denominata Leggi da in Automation 360.
La tabella seguente mostra i comandi che è attualmente possibile migrare.
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Comandi Enterprise
11 o Enterprise 10

actions e packages Automation 360 equivalenti

Connetti Esegue la migrazione al comando Connetti. Se si incontra una stringa di
connessione non supportata in Automation 360, i motivi possono variare in
base all’ambiente. Sono disponibili ulteriori dettagli come parte del processo
di migrazione. Contattare il Supporto tecnico se si necessita di assistenza per
risolvere il problema.
0 non è un valore di timeout valido in Automation 360. Il processo di
migrazione sostituisce 0 con un valore vuoto.

Esegui procedura
archiviata

Il nome del parametro e il parametro di output sono campi obbligatori in
Automation 360.

Important:  Dopo aver migrato il bot, fornisci il nome del parametro e il tipo
di parametro di output in action Esegui procedura memorizzata.

Consulta Database package on page 1449.

Ritardo

Il comando Ritardo viene migrato all'azione Ritardo in Automation 360. Le opzioni "Ritardo in millisecondi"
e "Ritardo in secondi" (Enterprise 11) sono state modificate in opzioni radio all'interno dell'area Unità di
tempo (Automation 360). Consulta Delay package on page 1478.

E-mail

Non esiste un concetto di sessione per i comandi e-mail in Enterprise 10 o Enterprise 11. Tuttavia,
Automation 360 contiene le azioni Connetti e Disconnetti per assicurarsi che le sessioni e-mail vengano
avviate e chiuse. Pertanto, durante la migrazione, il sistema posiziona l'azione Connetti prima della
rispettiva azione con l'e-mail e l'azione Disconnetti dopo la rispettiva azione con l'e-mail.
L'opzione Salva allegato del comando Ottieni tutti i messaggi è ora un'operazione azione dedicata
denominata Salva allegato nel pacchetto E-mail in Automation 360.
Per bots creati per automatizzare le attività correlate alle e-mail sul server Exchange Web Services (EWS),
il comando Ottieni tutti i messaggi viene migrato all'azione Ciclo con l'iterazione impostata su Per ogni
e-mail nella casella postale. Analogamente, i comandi Elimina ed Elimina tutti sono migrati alle
azioni Elimina ed Elimina tutti.
When you migrate Enterprise 11 bots that contain the Email package with Authentication type set to
OAuth2, most of the parameters included in the package migrate to the same values in Automation 360.
However, the following parameters migrate with different values:
• The IMAP and POP3 protocols migrate to the corresponding Email server in Automation 360.
• The Use Local timezone migrates to the Loop action as a Boolean value in Automation 360.

Consulta Email package on page 1493.

Gestione errori

I comandi Error Handling disabilitati non vengono migrati a Automation 360.
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Avvia gestione errori e Termina gestione errori sono migrati al blocco Prova/Cattura del pacchetto
Error handler in Automation 360. Molte opzioni disponibili in Begin Error Handling (Avvia gestione errori)
vengono migrate alle rispettive operazioni Automation 360.

Note:  To avoid an exception error when you use the Try/Catch block in a Loop, we recommend that you
validate all the command inputs.

Fare riferimento alla tabella seguente per i dettagli:

Comandi
Enterprise 11 o
Enterprise 10

actions e packages Automation 360 equivalenti

Continua Per impostazione predefinita, l'esecuzione prosegue dopo l'esecuzione del blocco
Cattura in Automation 360.

Sospendi L'azione Sospendi del pacchetto Attività viene aggiunta al blocco Cattura.

Scatta istantanea Quando l'opzione Scatta istantanea è selezionata e la posizione è fornita nel
campo Percorso file di Enterprise 11 bot, il bot migrato contiene:
• L'azione Acquisisci desktop di Screen package per acquisire la schermata

di errore.
• L'azione Registra su file di Log To File package per acquisire il messaggio di

errore in un file di testo.
• L'azione A stringa di Datetime package per convertire il valore di data e ora

in una stringa che verrà archiviata nel file di testo insieme al messaggio di
errore.

Le azioni di cui sopra vengono aggiunte al blocco Cattura del bot migrato,
mentre l'immagine acquisita e il messaggio di errore sono memorizzati nella
posizione fornita nel campo Percorso file del botEnterprise 11.
Quando le opzioni Scatta istantanea, Invia e-mail e Allega istantanea
sono selezionate e la posizione non è fornita nel campo Percorso file nel bot
Enterprise 11, il bot migrato contiene quanto segue:
• L'action Crea del package Folder per creare un percorso temporaneo per

archiviare l'immagine acquisita e il file di testo che contiene il messaggio di
errore.

• L'azione Acquisisci desktop di Screen package per acquisire la schermata
di errore.

• L'azione Registra su file di Log To File package per acquisire il messaggio di
errore in un file di testo.

• L'azione A stringa di Datetime package per convertire il valore di data e ora
in una stringa che verrà archiviata nel file di testo insieme al messaggio di
errore.

• L'action Invia di Email package per inviare una notifica e-mail con
l'immagine e il file di testo allegati.

• L'action Elimina del package File per eliminare l'immagine e il file di testo
archiviati nel percorso temporaneo.

Le actions di cui sopra sono aggiunte al blocco Cattura del bot migrato.

Esegui attività L'azione Esegui del pacchetto Attività viene aggiunta al blocco Prova.
Quando un figlio bot riscontra un errore, bot prosegue con l’esecuzione
dell’operazione successiva dell’elemento padre bot.
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Comandi
Enterprise 11 o
Enterprise 10

actions e packages Automation 360 equivalenti

Registra i dati nel
file

L'azione Registra in un file viene aggiunta al blocco Cattura.

Invia e-mail L'azione Invia dal pacchetto E-mail viene aggiunta al blocco Cattura.
Vengono inoltre migrate le variabili TaskBot e i valori delle variabili inviati come
allegato e-mail utilizzando l'opzione Allega variabile.

Assegnazione
variabile

L'azione Assegna del pacchetto Stringa viene aggiunta con la rispettiva
condizione nel blocco Cattura.

Consulta Error handler package on page 1523.

Excel

I comandi Excel Enterprise 10/Enterprise 11 vengono migrati alle rispettive azioni Automation 360 del
pacchetto Excel avanzato.
In Enterprise 11, un bot è in grado di aprire un foglio di calcolo di Microsoft Excel anche quando non è
fornita un’estensione di file. In Automation 360, i bots migrati utilizzano l'azione Apri nel pacchetto Excel
advanced per aprire un foglio di calcolo di Microsoft Excel quando non viene fornita un'estensione di file.
In Enterprise 10/Enterprise 11, i dati restituiti dai comandi Ottieni più celle e Ottieni tutte le celle
vengono restituiti al comando Ciclo > Ogni riga di un dataset Excel. In Automation 360, le funzionalità
di Ottieni più celle e Ottieni tutte le celle sono disponibili in Ciclo > Ogni riga di un dataset Excel,
per cui i valori di questi comandi sono migrati al ciclo anziché alle azioni effettive.
I Bots che utilizzano il comando Ottieni cella singola con le opzioni Specifica cella e Ottieni valore
cella vengono migrati all'action Ottieni cella singola del Excel advanced package con le opzioni
Specifica cella e Leggi valore cella selezionate dopo la migrazione.
When you run a migrated bot with the Excel Advanced > Cell range option, ensure that you use a
numeric value as the last character in the From cell and To cell fields (for example, testa1). The last
character cannot be an alpha character.
La tabella seguente mostra le modifiche ai nomi delle operazioni:

Comandi Enterprise 11 o
Enterprise 10

actions e packages Automation 360 equivalenti

Salva foglio di calcolo Salva cartella di lavoro

Apri foglio di calcolo Apri

Chiudi foglio di calcolo Chiudi

Note:  Quando migri un bot con Excel:Con l'azione Chiudi, in
Enterprise 10/Enterprise 11, il bot ignora l'azione Salva per il file di
sola lettura, mentre in Automation 360 viene visualizzato il seguente
prompt: Il file esiste già.
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Comandi Enterprise 11 o
Enterprise 10

actions e packages Automation 360 equivalenti

Ottieni celle Suddiviso nelle azioni Ottieni singola cella e Ottieni più celle

Note:  L'azione Ottieni celle recupera l'output in diversi formati per
Enterprise 10/Enterprise 11 e Automation 360 per tipi di dati specifici,
come Booleano e Data.

Attiva foglio Passa al foglio

Note:  In Enterprise 11, il bot contenente il comando Attiva foglio
non esegue operazioni su un foglio di lavoro nascosto. Tuttavia, dopo
la migrazione in Automation 360, il bot che contiene l'azione Passa al
foglio si sposta sul foglio di lavoro nascosto ed esegue operazioni su
di esso. Al termine delle operazioni, il foglio di lavoro rimane nascosto
e non viene attivato.

Trova/Sostituisci Suddiviso nelle azioni Trova e Sostituisci
Quando migri un bot con l'azione Excel > Trova e se il valore è
presente all'inizio di un indirizzo di cella, il bot migrato recupera gli
stessi risultati di output in una sequenza diversa per Trova testo per
Enterprise 11 e Automation 360. Ad esempio, se gli indirizzi delle celle
A2, B5 e D15 hanno il valore XYZ e cerchi XYZ nell'intervallo A2:D15,
il bot Enterprise 11 raccoglie il risultato nella sequenza: B5, D15 e A2.
Tuttavia, il bot migrato raccoglierà i risultati in una sequenza diversa:
A2, B5 e D15 dopo la migrazione a Automation 360.

Consulta Excel advanced package on page 1533.
• In Enterprise 11 o Enterprise 10 e in Automation 360, una sessione (utilizzata per aprire un foglio di

calcolo di Microsoft Excel) può essere condivisa tra il padre bot e un figlio bot. In Automation 360, è
possibile chiudere una sessione condivisa dal figlio bot.

Note:  Quando utilizzi più fogli di calcolo per automatizzare un'operazione, ti occorre utilizzare nomi
di sessione diversi per ciascun foglio di calcolo. Se desideri utilizzare lo stesso nome di sessione per
automatizzare tutti i fogli di calcolo, devi chiudere la sessione di un foglio di calcolo prima di utilizzare lo
stesso nome di sessione per un altro foglio di calcolo.

• In Enterprise 11 o Enterprise 10, quando tenti di salvare un foglio di calcolo di sola lettura, non viene
visualizzato alcun errore. Tuttavia, in Automation 360, quando tenti di salvare un foglio di calcolo di sola
lettura, viene visualizzato un messaggio di errore che indica che la cartella di lavoro non può essere
salvata.
Soluzione: Assicurati di disporre dell'accesso in Modifica per il file e ritenta l'operazione. Se il
problema persiste, contatta l'amministratore di sistema. L'azione Scrivi non è consentita su tali file.

File e cartella

Tutti i comandi di File/Cartella sono stati suddivisi in pacchetti File e Cartella.
Le seguenti azioni correlate a File sono state modificate in Automation 360:
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Comandi Enterprise 11 o
Enterprise 10

actions e packages Automation 360 equivalenti

Copia file Operazione di copia di File package

Crea file Operazione di creazione di File package

Crea collegamento rapido file action Crea collegamento rapido del package File

Elimina file Operazione di eliminazione di File package

Apri file Operazione di apertura di File package

Stampa file Operazione di stampa di File package

Rinomina file Operazione di ridenominazione di File package

Decomprimi file Operazione di decompressione di Folder package

Comprimi file Operazione di compressione di Folder package

Le seguenti azioni correlate a Cartella sono state modificate in Automation 360:

Comandi Enterprise 11 o
Enterprise 10

actions e packages Automation 360 equivalenti

Copia cartella Operazione di copia di Folder package

Crea cartella Operazione di creazione di Folder package

Crea collegamento rapido
cartella

action Crea collegamento rapido del package Folder

Elimina cartella Operazione di eliminazione di Folder package

Apri cartella Operazione di apertura di Folder package

Rinomina cartella Operazione di ridenominazione di Folder package

Consulta File package on page 1562 e Folder package on page 1571.
I bots Enterprise 11 possono utilizzare espressioni regolari nei comandi Copia file, Elimina file, Stampa
più file, Rinomina file e Comprimi file per cercare i file in cui desideri eseguire un'operazione. Anche le
operazioni equivalenti in Automation 360 sono in grado di utilizzare espressioni regolari per cercare i file su
cui si desidera eseguire un’operazione.

FTP/SFTP

Tutti i comandi di FTP/SFTP sono migrati ad azioni Automation 360 equivalenti del pacchetto FTP/SFTP.
Non vi è alcun cambiamento nel comportamento o nel nome dei comandi.
Le azioni Ottieni file e Ottieni cartella restituiscono errori di runtime se hanno criteri aggiuntivi basati
sulle date fornite come variabili con valori in un formato diverso da MM/GG/AAAA. Ti occorre quindi
correggere tali istanze dopo la migrazione del bot. Durante il processo di migrazione, queste due operazioni
aggiungono anche gestori di errori aggiuntivi in bots migrati quando il filtraggio viene eseguito sulla base di
data e ora.
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If/Else

Variabili contenenti condizione di stringa “If” con gli operatori seguenti viene migrato come
condizione di stringa in Automation 360:
• =
• < >
• Includi
• Non include

Per la variabile Casuale del sottotipo Stringa,
Automation 360 aggiunge l'azione Genera stringa
casuale del pacchetto Stringa per generare una
stringa casuale al di sopra della condizione Se e
assegna il valore alla rispettiva variabile migrata.

Variabile contenente condizione di numero “If” con gli operatori seguenti viene migrato come
condizione di numero in Automation 360:
• >=
• <=
• >
• <

Per la variabile Casuale del sottotipo Numero,
Automation 360 aggiunge l'azione Assegna un
numero casuale del pacchetto Numero per
generare una stringa casuale al di sopra della
condizione Se e assegna il valore alla rispettiva
variabile migrata.

Variabile di tipo valore contenente data Il sistema tenta di valutare se una condizione su
una variabile ha un valore di data. Se rileva tale
valore, migra Se con la condizione Data e ora
in Automation 360. In caso contrario, il sistema
esegue la migrazione come condizione di stringa
o numero in base all’operatore utilizzato. In questi
casi, è necessario modificarlo in una condizione
di data dopo la migrazione bot se è implicata
un’operazione di data.
Inoltre, potresti dover modificare il formato della
data in uno compatibile con i dati. Il formato
predefinito utilizzato per convertire una data in
stringa è MM/dd/yyyy HH:mm:ss.
Consulta If package on page 1625.

Image Recognition Il comando Se con la condizione Riconoscimento
delle immagini in Enterprise 10/Enterprise 11 può
diventare una delle seguenti azioni in Automation
360, in base alle opzioni Enterprise 10/ selezionate:
• Se > File immagine rilevato in file

immagine - Creato se in Immagine1 è
selezionata l'opzione Da file e in Immagine2
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l'opzione Da file è selezionata in Enterprise 10 o
Enterprise 11.

• Se > File immagine rilevato in una finestra
- Creato se in Immagine1 è selezionata l'opzione
Da file e in Immagine2 l'opzione Da finestra è
selezionata in Enterprise 10 o Enterprise 11.

• Se > Finestra rilevata in file immagine -
Creato se in Immagine1 è selezionata l'opzione
Da finestra e in Immagine2 l'opzione Da file è
selezionata in Enterprise 10 o Enterprise 11.

• Se > Finestra rilevata in una finestra -
Creato se in Immagine1 è selezionata l'opzione
Da finestra e in Immagine2 l'opzione Da
finestra è selezionata in Enterprise 10 o
Enterprise 11.

Consulta If package on page 1625.

Important:  Se una condizione implica una data, in una determinata situazione, devi modificare le
informazioni migrate in una condizione di data dopo la migrazione del bot.

La tabella seguente mostra come varie condizioni vengono migrate alle rispettive condizioni Automation
360 .

Comandi Enterprise 11 o
Enterprise 10

actions e packages Automation 360 equivalenti

Attività riuscita o Attività non
riuscita

Migrazione alla condizione Se equivalente del pacchetto TaskBot.

Script riuscito o Script non
riuscito

Lo script riuscito/non riuscito è migrato alle rispettive azioni Se
> Script riuscito e Se > Script non riuscito del pacchetto
Automazione legacy.

Proprietà oggetto Migrazione eseguita alle condizioni Se esiste la > finestra > 
Condizione e Oggetto condizioni del pacchetto Registratore.

Applicazione non in
esecuzione o Applicazione in
esecuzione

Migrazione alla condizione Se equivalente del pacchetto
Applicazione.

File esistente, File inesistente,
Data del file, Dimensioni del
file

Migrazione alla condizione Se equivalente del pacchetto File.

Cartella esistente o Cartella
inesistente

Migrati alla condizione Se equivalente del pacchetto Cartella.

Ping riuscito o Ping non
riuscito

Migrati alla condizione Se equivalente del pacchetto Ping.

Controllo Web esistente o
Controllo Web inesistente

Migrati alla condizione Se equivalente del pacchetto Automazione
legacy.
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Comandi Enterprise 11 o
Enterprise 10

actions e packages Automation 360 equivalenti

Finestra esistente/Finestra
inesistente

I seguenti comandi configurati con l'opzione "Mostra finestre figlio e
nascoste" selezionata vengono migrati al pacchetto Automation 360
Automazione legacy:
• Se esiste la > finestra > Condizione
• Se non esiste la > finestra > Condizione

Logica riuscita/Logica non
riuscita

Il comando Se viene migrato rispettivamente a Se > Attività
riuscita e Se > Attività non riuscita.
Il comando Altrimenti se viene migrato rispettivamente a
Altrimenti se > Attività riuscita e Altrimenti se > Attività
non riuscita.
I Bots che utilizzano la condizione Logica riuscita o Logica non
riuscita e restituiscono una variabile di output al bot padre possono
essere migrati a Automation 360.
I Bots che usano Credential Vault variabili vengono trasferiti da una
Logic di MetaBot a un'altra Logic di MetaBot per entrambi i comandi
Se > Logica riuscita e Se > Logica non riuscita.
Puoi migrare un MetaBot con Logic (padre) che include una Logic
(figlio) rinominata. Se una Logic figlio viene rinominata dopo essere
stata mappata alla Logic padre, la mappatura di questa Logic padre
viene migrata con il nuovo nome.
Applicabile dalla v.25: i bots Enterprise 11 o Enterprise 10
che utilizzano il comando Se > Logica riuscita o Se > Logica
non riuscita vengono migrati quando una Logic MetaBot di
riferimento viene rinominata o ne viene cambiato il percorso dopo
la mappatura. Se una Logic MetaBot viene rinominata o ne viene
cambiato il percorso dopo la mappatura nei TaskBot, i TaskBot
vengono migrati con il nuovo nome o percorso della Logic MetaBot.
For information about how a bot is migrated if the Logic
Successful command passes a Credential Vault variable, see Esegui
logica on page 1269.

Service is running/Service is
not running

The If command is migrated to If > Service is running and If >
Service is not running.
The ElseIf command is migrated to Else If > Service is running
and Else If > Service is not running.

Image Recognition

Il comando Riconoscimento delle immagini è suddiviso nelle azioni Trova immagine file all'interno
dell'immagine della finestra e Trova immagine finestra all'interno di un'altra immagine
finestra in Automation 360.
In Automation 360, l'opzione Avanzate viene utilizzata come modalità di confronto predefinita. Le altre
modalità di confronto (come Scala di grigi, Normale e Monocromatico) che esistevano in Enterprise
10 e Enterprise 11 sono nascoste in Automation 360, ma corrispondono al comportamento con Automation
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360 dopo la migrazione. Il processo di migrazione mappa automaticamente le informazioni e non influisce
su bots correlati.
When you run a migrated bot with Image Recognition that contains an If, IF/ELSE, or Loop action, an error
displays when the window does not exist.
La migrazione di bots con il comando Riconoscimento delle immagini potrebbe non riuscire se il
comando utilizza qualsiasi tipo di file diverso da quanto segue:
• jpg
• .jpeg
• .jpe
• .fif
• .bmp
• .gif

Consulta Image Recognition package on page 1631.

Insert Keystrokes

Questo comando si chiama Simula sequenze di tasti in Automation 360. Sono state modificate le
seguenti convenzioni di digitazione:

Comandi Enterprise 11 o Enterprise 10 actions e packages Automation 360 equivalenti

[PAGINA SU] [PAGINA-SU]

[BLOC NUM] [BLOC-NUM]

[BLOC SCORR] [BLOC-SCORR]

[PAGINA GIÙ] [PAGINA-GIÙ]

[BLOC MAIUSC] [BLOC-MAIUSC]

[FRECCIA SU] [FRECCIA-SU]

[FRECCIA SINISTRA] [FRECCIA-SINISTRA]

[CLIC CON IL TASTO DESTRO] [MENU]

[FRECCIA DESTRA] [FRECCIA-DESTRA]

[FRECCIA GIÙ] [FRECCIA-GIÙ]

[ALT GR GIÙ] [ALT-GR GIÙ]

[ALT GR SU] [ALT-GR SU]

[$] [DOLLARO]

In Enterprise 11 o Enterprise 10, il tempo di ritardo è suddiviso sulla base dei caratteri totali e applicato tra
ogni sequenza di caratteri. In Automation 360, il ritardo specificato si applica al tempo che intercorre tra
ogni battuta.
The legacy Get keystrokes delay action in Automation 360 supports migrated bots that include the
Simulate keystrokes action. The legacy Get keystrokes delay action matches the duration of
delay defined in Enterprise 11 bots for the Insert Keystrokes command and simulates the same value
in Automation 360 for the Simulate keystrokes action. Dopo la migrazione, se le sequenze di tasti
vengono digitate più velocemente (per esempio, le sequenze di tasti usate per eseguire scorciatoie in
Office 365 Excel), aggiungi l'action Ritarda dopo l'action Simula sequenze di tasti per garantire che i
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bots vengano eseguiti senza problemi. The legacy Get keystrokes delay action provides similar delay,
as seen in Enterprise 11, in the migrated bots to ensure that the migrated bots produce the same output
as seen in Enterprise 11. However, this change leads to the command being split into multiple lines after
migration.
Se l'opzione Crittografa sequenze di tasti è selezionata in Enterprise 11 o Enterprise 10 bots, dopo la
migrazione il valore viene archiviato in Credential Vault. Il processo di migrazione crea un armadietto in
Credential Vault con gli attributi seguenti:
• Il nome dell'armadietto creato in Automation 360 è AAE_<folder_name> (folder_name è la cartella in

cui è disponibile il bot migrato).
Il bot migrato utilizza tale armadietto. Gli utenti che dispongono di qualsiasi autorizzazione per la
cartella che contiene il bot possono accedere all'armadietto. L'utente di esecuzione della migrazione
deve avere l'autorizzazione Crea attributi standard per una credenziale.

• Un armadietto contiene solo una credenziale per ogni bot. Il nome della credenziale creata è
Keystrokes_<nome bot> per TaskBots e Keystrokes_<Nome Metabot>_<Nome logico> per
MetaBots.

• Gli attributi per l'armadietto vengono creati con il nome Encrypted_keystrokes.

Se è già presente un armadietto, una credenziale o un attributo con lo stesso nome, il sistema
aggiunge un valore numerico al nome dell'armadietto, della credenziale e dell'attributo. Ad esempio,
AAE_<folder_name>_1, Keystrokes_<bot name>_1 e Encrypted_keystrokes_1
rispettivamente. Se il nome dell'armadietto, della credenziale o dell'attributo contiene più di 50 caratteri, il
sistema taglia i caratteri alla fine per limitare il nome a 50 caratteri.

Note:  Non è possibile migrare un bot disponibile sul dispositivo locale con l'opzione Crittografia
sequenze di tasti selezionata.

Consulta Simulate keystrokes package on page 1867.

Launch Website

Questo comando è migrato a action Apri del pacchetto Browser in Automation 360.
I comandi con opzione Edge o Ignora browser predefinito deselezionati nel prodotto legacy sono
modificati automaticamente per utilizzare il Browser predefinito dopo la migrazione.
I bots Enterprise 11 che aprono un sito Web in una nuova finestra di tutti i browser supportati da
Automation 360 possono essere migrati. I bots Enterprise 11 che aprono il sito Web in una scheda nuova
o esistente del browser Internet Explorer può essere migrato a Automation 360. L'opzione equivalente per
aprire il sito Web in una nuova finestra, scheda o scheda esistente è selezionata nei bots migrati.

Note:  Il supporto per il browser legacy Microsoft Edge non è più disponibile, mentre il browser Microsoft
Edge Chromium è supportato. Di conseguenza, non è possibile creare nuovi bots usando il browser Legacy
Microsoft Edge. Tuttavia, i bots esistenti creati col browser Legacy Microsoft Edge esistente possono essere
aggiornati utilizzando altri browser supportati come Google Chrome o Microsoft Edge Chromium.

Consulta Browser package on page 1425.

Important:  Se hai creato bots in Enterprise 11 o Enterprise 10 utilizzando il browser Microsoft Edge, devi
prima eseguire il porting di questi bots in un altro browser, quindi puoi eseguire la migrazione.
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Log To File

Questo comando viene migrato all'azione Registra nel file Automation 360.
Consulta Log To File package on page 1680.

Loop
La tabella seguente mostra come il comando Loop viene migrato a actions e packages Automation 360
equivalenti:

Comandi Enterprise 11 o
Enterprise 10

actions e packages Automation 360 equivalenti

Comando Loop con l'opzione
Tempi selezionata

action Loop del package Loop con l'opzione Per n volte
selezionata.

Comando Loop con l'opzione
Elenco selezionata

action Loop del package Loop con l'opzione Per n volte
selezionata.

Comando Loop con l'opzione
Ogni riga di un dataset
Excel selezionata

action Loop del package Loop con l'opzione Per ogni riga nel
foglio di lavoro selezionata.
La variabile di sistema $Excel Column$ utilizzata all'interno del
loop è ora una variabile definita dall'utente specificata nello stesso
iteratore.

Comando Loop con l'opzione
Ogni riga di un set di dati
della query SQL selezionata

action Loop del package Loop con l'opzione Per ogni riga in un
set di dati di query SQL selezionata.
La variabile di sistema $Dataset Column$ utilizzata all'interno
del loop è ora una variabile definita dall'utente specificata nello
stesso iteratore.

Comando Loop con l'opzione
Ogni file in una cartella
selezionata

action Loop del package Loop con l'opzione Per ogni file in una
cartella selezionata.
Le variabili di sistema $Filename$ e $Extension$ sono ora
il nome delle chiavi e l'estensione di una variabile di dizionario
specificata nello stesso iteratore. In Enterprise 11, il bots non ha
riscontrato un errore se la cartella non esiste. In Automation 360,
the migrated bots encounter an error if the folder does not exist.

Comando Loop con l'opzione
Ogni cartella in una cartella
selezionata

action Loop del package Loop con l'opzione Per ogni cartella in
una cartella selezionata.
La variabile di sistema $Folder name$ utilizzata all'interno del
loop è ora una variabile definita dall'utente specificata nello stesso
iteratore. In Enterprise 11, il bots non ha riscontrato un errore
se la cartella non esiste. In Automation 360, the migrated bots
encounter an error if the folder does not exist.

Comando Loop con l'opzione
Ogni riga in un file CSV/di
testo selezionata

action Loop del package Loop con l'opzione Per ogni riga in
CSV/TXT selezionata.
La variabile di sistema $Filedata Colum$ utilizzata all'interno del
loop è ora una variabile definita dall'utente specificata nello stesso
iteratore.
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Comandi Enterprise 11 o
Enterprise 10

actions e packages Automation 360 equivalenti

Comando Loop con l'opzione
Ogni messaggio e-mail nel
server e-mail selezionata

action Loop del package Loop con l'opzione Per ogni e-mail
nella casella di posta selezionata.
Le variabili di sistema $Email Cc$,$Email From$,
$Email Message$, $Email Received Date$, $Email
Received Time$, $Email Subject$ e $Email To$ sono ora
rispettivamente le chiavi emailCc, emailFrom, emailMessage,
emailReceivedDate, emailReceivedTime, emailSubject
ed emailTo di una variabile di dizionario specificata nello stesso
iteratore.

Comando Loop con l'opzione
Ogni nodo in un database
XML selezionata

action Loop del package Loop con l'opzione Per ogni nodo in un
database XML selezionata.
La variabile di sistema $XML Data Node$ utilizzata all'interno del
loop è ora una variabile definita dall'utente specificata nello stesso
iteratore.

I comandi seguenti configurati con l'opzione Mostra finestre figlio e nascoste selezionata vengono
migrati al pacchetto Automation 360 Automazione legacy:
• La finestra > Condizione > del loop esiste
• La finestra > Condizione > del loop non esiste

Variabili contenenti condizione di stringa “If” con gli operatori seguenti viene migrato come
condizione di stringa in Automation 360:
• =
• < >
• Includi
• Non include

Per la variabile Casuale del sottotipo Stringa,
Automation 360 aggiunge l'azione Genera stringa
casuale del pacchetto Stringa per generare una
stringa casuale al di sopra della condizione Se e
assegna il valore alla rispettiva variabile migrata.

Variabile contenente condizione di numero “If” con gli operatori seguenti viene migrato come
condizione di numero in Automation 360:
• >=
• <=
• >
• <

Per la variabile Casuale del sottotipo Numero,
Automation 360 aggiunge l'azione Assegna un
numero casuale del pacchetto Numero per
generare una stringa casuale al di sopra della
condizione Se e assegna il valore alla rispettiva
variabile migrata.
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Variabile contenente condizioni di data Il sistema tenta di valutare se una condizione su
una variabile ha un valore di data. Se rileva tale
valore, migra Se con la condizione Data e ora
in Automation 360. In caso contrario, il sistema
esegue la migrazione come condizione di stringa
o numero in base all’operatore utilizzato. In questi
casi, è necessario modificarlo in una condizione
di data dopo la migrazione bot se è implicata
un’operazione di data.
Inoltre, potrebbe anche essere necessario
modificare il formato della data in uno compatibile
con i dati. Il formato predefinito utilizzato per
convertire una data in stringa è MM/dd/yyyy
 HH:mm:ss.

Variabile tipo elenco Il loop su una condizione variabile di tipo Elenco
è migrato alla condizione Stringa o Numero in
base all'operatore utilizzato nella condizione. Il
sistema utilizza l’indice di elenco per convalidare la
condizione.

Controllo Web esistente o Controllo Web
inesistente

Il loop con le condizioni Controllo Web esistente
e Controllo Web non esistente viene migrato
rispettivamente a Ciclo > Mentre esistono
condizioni di controllo Web e Controllo Web
inesistente del pacchetto Automazione legacy.

Consulta la tabella seguente per comprendere come varie condizioni vengono migrate alle rispettive
condizioni Automation 360.

Condizioni Enterprise 11 o
Enterprise 10

actions e packages Automation 360 equivalenti

Controllo Web esistente o Controllo
Web inesistente

Migrazione alla condizione Se equivalente del pacchetto
Supporto legacy.

Proprietà oggetto Migrazione alla condizione Oggetto del pacchetto
Registratore.

Applicazione non in esecuzione o
Applicazione in esecuzione

Migrazione alla condizione Se equivalente del pacchetto
Applicazione.

File esistente, File inesistente, Data
del file, Dimensioni del file

Migrazione alla condizione Se equivalente del pacchetto File.

Cartella esistente o Cartella
inesistente

Migrati alla condizione Se equivalente del pacchetto Cartella.

Ping riuscito o Ping non riuscito Migrati alla condizione Se equivalente del pacchetto Ping.

Il servizio è in esecuzione o Il
servizio non è in esecuzione

Migrazione alla condizione Se equivalente del pacchetto
Servizio.

La tabella seguente mostra i comandi Ciclo supportati per la migrazione e le rispettive mappature in
Automation 360.

Comandi Enterprise 11 o Enterprise 10 actions e packages Automation 360 equivalenti

Esci dal ciclo Interrompi
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Comandi Enterprise 11 o Enterprise 10 actions e packages Automation 360 equivalenti

Continua

Message Box

Questo comando viene migrato all'azione Finestra di messaggio in Automation 360.
Consulta Message box package on page 1690.

Object Cloning

Questo comando viene migrato al pacchetto Registratore > Acquisisci in Automation 360.
La migrazione è supportata per le applicazioni che utilizzano le seguenti tecnologie (anche quando si
trovano all’interno di un ambiente Citrix):
• MSAA (Tecnologia desktop standard)
• Browser Google Chrome
• Browser Internet Explorer
• Java desktop
• Web Java
• UI Automation (avanzata)
• Browser Firefox (oggetto basato solo su tecnologia HTML)
• Microsoft Silverlight versione 5

La tabella seguente elenca le differenze di comportamento tra Enterprise 11 o Enterprise 10 e Automation
360:

Comportamento di Enterprise 11 o Enterprise
10

Comportamento di Automation 360

I comandi GetAllChidrenName e
GetAllChidrenValue restituiscono valori di
variabile di tipo stringa

Le actions equivalenti in Automation 360
restituiscono valori di elenco. Il processo di
migrazione unisce i valori dell'elenco e li archivia
in una variabile di stringa per mantenere
comportamenti bot coerenti tra le versioni.

In Enterprise 11, il comando viene utilizzato per
acquisire il controllo in un'immagine

L'intera immagine della finestra viene acquisita
con il controllo evidenziato con un rettangolo
rosso

La clonazione degli oggetti con l'azione Esporta in CSV in Enterprise 10/Enterprise 11 è migrata nelle
seguenti combinazioni di pacchetti/azioni, in quanto l'azione non esiste in Automation 360:
• L'azione Acquisisci salva i dati acquisiti in una variabile tabella.
• L'azione Scrivi su file del pacchetto Tabella dati viene quindi utilizzata per salvare i dati dalla

variabile della tabella nel file CSV.

Il titolo della finestra è copiato dal comando di origine all’operazione di destinazione.
Anche le coordinate X, Y e il titolo della finestra sono migrati a Automation 360.
Le modalità di riproduzione o di esecuzione Coordinata and Immagine da Enterprise 11 sono migrate
come le actions seguenti:
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Modalità di riproduzione come coordinate:

Modalità di riproduzione come coordinate Operazioni con il clic del mouse: Le operazioni
Clic, Clic destro, Clic sinistro, Clic centrale e
Doppio clic sono migrate nell'azione Mouse: come
combinazione di pulsante ed eventi. I corrispondenti
tasti del mouse con gli eventi sono migrati come
illustrato:
• Clic cambia in Clic con tasto sinistro
• Clic destro cambia in Clic con tasto destro
• Clic sinistro cambia in Clic con tasto sinistro
• Clic centrale cambia in Clic con tasto centrale
• Doppio clic cambia in Doppio clic con tasto

sinistro

Ottieni testo L'operazione Ottieni testo è migrata come una
combinazione di azioni che includono Mouse: Clic
con tasto sinistro, Appunti: Cancella, Elimina e
Simula battuta.

Imposta testo L'operazione Imposta testo è migrata come una
combinazione di azioni che includono Mouse: Clic
con tasto sinistro, Appunti: Cancella, Elimina e
Simula battuta.

La tabella seguente mostra le modifiche ai nomi delle proprietà per i comandi e gli oggetti acquisiti
utilizzando Clonazione dell'oggetto. Il processo di migrazione mappa automaticamente le modifiche
a nomi. Tuttavia, se una proprietà viene utilizzata all’interno di una variabile, è necessario immettere
manualmente il nuovo nome nella variabile.

Nome proprietà Enterprise 11 o Enterprise 10 Automation 360 nome proprietà

ID oggetto ID

Tipo Tipo di controllo

Stato/i States

Azione DefaultAction

Grassetto IsBold

Corsivo IsItalic

Sottolineato IsUnderline

Cancella IsStrikethrough

Apice IsSuperscript

Pedice IsSubscript

Colore di sfondo BackgroundColor

Colore in primo piano ForegroundColor

Carattere FontFamily

Dimensioni carattere FontSize

Rientro prima riga FirstLineIndent

Rientro sinistro LeftIndent

© 2023 Automation Anywhere. All rights reserved.     1264



    Automation Anywhere - Migrazione a Automation 360

Nome proprietà Enterprise 11 o Enterprise 10 Automation 360 nome proprietà

Rientro destro RightIndent

Interlinea LineSpacing

Spazio sopra SpaceAbove

Spazio sotto SpaceBelow

Nome elemento ItemName

Valore elemento ItemValue

Animato IsAnimated

Maiuscole/Minuscole Maiusc

Spessore carattere FontWeight

Allineamento orizzontale HorizontalAlignment

Nascosto IsHidden

Sola lettura IsReadOnly

Margine inferiore BottomMargin

Margine sinistro LeftMargin

TopMargin TopMargin

Margine destro RightMargin

Colore della linea in alto OverlineColor

Colore della linea sovrapposta StrikethroughColor

Stile tabulazioni Schede

Orientamento del testo TextFlowDirection

Colore sottolineatura UnderlineColor

ID HTML IEID

Nome HTML IEName

Alt HTML IEAlt

Tag HTML IETag

Classe HTML IEClass

Testo interno HTML IEInnerText

Indice sorgente HTML IESourceIndex

HRef HTML IEHref

Valore HTML IEValue

Tipo HTML IEType

ID classe HTML IEClassId

Titolo HTML IETitle

Indice tag HTML IETagIndex
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Nome proprietà Enterprise 11 o Enterprise 10 Automation 360 nome proprietà

HasFrame HTML IEHasFrame

FrameID HTML IEFrameID

Nome frame HTML IEFrameName

Src frame HTML IEFrameSrc

Larghezza HTML IEWidth

HTML in alto IETop

HTML a sinistra IELeft

Altezza HTML IEHeight

Percorso frame HTML IEFramePath

Raccolta di elementi ItemCollection

Motore OCR OCREngine

Occorrenza OCR OCROccurrence

Tipo di controllo di riga RowControlType

GetSelectedIndex GetSelectedIndex

GetSelectedText GetSelectedText

• Il processo di migrazione tronca i dati a 64 KB se i bots Enterprise 11 o Enterprise 10 che utilizzano un
oggetto e qualsiasi proprietà di tale oggetto contengono dati di dimensioni superiori a 64 KB. In questo
modo si garantisce che questi bots non rilevino un errore dopo la migrazione.

• In Enterprise 11, puoi rimuovere il tipo di controllo di un oggetto dai criteri di ricerca, tuttavia questa
opzione non è disponibile in Automation 360. In Automation 360, l'azione di cattura viene eseguita solo
su oggetti con gli stessi tipi di controllo. Se desideri usare questa azione su oggetti con diversi tipi di
controllo, devi acquisire questi tipi di controllo in azioni di cattura separate.

Consulta Utilizzo dell'action Acquisisci on page 1763.

OCR

Tutti i comandi di OCR sono migrati ad azioni Automation 360 equivalenti del pacchetto OCR. Non vi è
alcun cambiamento nel comportamento o nel nome dei comandi.
In Enterprise 11, le opzioni OCR ABBYY, MODI, TESSERACT e TOCR sono disponibili come motori OCR.
In Automation 360, per impostazione predefinita, viene usato solo il motore OCR ABBY.
Consulta OCR package on page 1697.

Open Program/File
Questo comando viene migrato all'azione Apri programma/file del pacchetto Applicazione. In
Enterprise 10/Enterprise 11, questo comando non genera un errore se fornisci un valore errato nel campo
Inizia in. Automation 360 convalida il valore immesso per lo stesso campo e genera un errore durante
l'esecuzione del bot.
Consulta Application package on page 1402.
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Important:  Gli utenti devono modificare il bot come pertinente, se desiderano continuare anche se il
campo del valore Avvia in non è corretto.

PDF integration

La tabella seguente mostra il comando PDF integration e i suoi actions e packages equivalenti in
Automation 360:

Comandi Enterprise 11 o Enterprise 10 actions e packages Automation 360 equivalenti

Unisci documento Unisci documento

Da PDF a immagine Estrai immagine

Estrai campi modulo Estrai campo

Estrai testo Estrai testo

Dividi documenti Dividi documenti

Codifica documento Codifica documento

Decodifica documento Decodifica documento

Se bot Enterprise 11 utilizza il comando Estrai campi modulo e memorizza i valori in Credential Vault, il
processo di migrazione migra questi valori in Automation 360 Credential Vault.
The output of an Enterprise 11 bot is mapped with multiple variables in the equivalent actions of the PDF
package after that bot is migrated to Automation 360. This reduces the number of actions in the migrated
bot because a separate action is no longer required to map output to a variable.
Consulta PDF package on page 1732.

PGP

Tutti i comandi di PGP sono migrati ad azioni Automation 360 equivalenti del pacchetto PGP. Non vi è
alcun cambiamento nel comportamento o nel nome dei comandi.
Consulta PGP package on page 1740.

Play Sound

Tutti i comandi di Riproduci audio sono migrati a operazioni equivalenti del pacchetto Audio in Automation
360.
Automation 360 supporta solo i tipi di file .mp3 e .wav nell'operazione Riproduci file multimediale.
Consulta Play Sound package on page 1742.

Printer

Stampante predefinita, Rimuovi stampante e Seleziona stampante predefinita sono migrati alle
azioni equivalenti del pacchetto Stampante in Automation 360.
Consulta Printer package on page 1743.
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Prompt

Tutti i comandi di Prompt sono migrati ad azioni Automation 360 equivalenti del pacchetto Prompt.
La tabella seguente mostra i comandi che è possibile migrare con le modifiche dei nomi.

Comandi Enterprise 11 o Enterprise 10 actions e packages Automation 360 equivalenti

Richiedi valore Si converte nell'azione Per valore. Inoltre,
l'azione Simula sequenza di tasti viene
aggiunta sotto l'azione Per valore per
eseguire le sequenze di tasti sul titolo specifico
della finestra. Ciò serve a mantenere il
comportamento di esecuzione del vecchio bots.

Richiedi file Per file

Richiedi cartella Per cartella

Richiedi Sì/No Per sì/no

Consulta Prompt package on page 1745.

Read from CSV/Text

Leggi da CSV/Testo viene convertito nelle azioni Apri, Leggi e Chiudi nel pacchetto Automation 360
CSV/TXT.
Se il bot Enterprise 10/Enterprise 11 sta utilizzando una variabile come nome di sessione e l'azione Ciclo
utilizzata per leggere tutte le righe di CSV/TXT sta utilizzando un nome di sessione dai valori codificati
anziché una variabile, ti occorre rivedere il bot migrato e impostare la variabile di output dell'azione CSV/
TXT > Leggi nel rispettivo ciclo. In caso contrario, verrà visualizzato un errore di interfaccia utente
quando si modifica Automation 360 bot.
In Automation 360, se il file CSV/TXT non è presente nel percorso del file specificato, il bot restituisce un
messaggio di errore, mentre in Enterprise 11, il bot non restituisce tale messaggio.

Important:  Esaminare il bot migrato e impostare la variabile di output dell'azione CSV/TXT > Leggi nel
rispettivo loop.

REST Web Service

L'opzione Salva intestazione in in Enterprise 11 è migrata in Automation 360. Questa opzione
consente di archiviare l’intestazione della risposta nella matrice e nelle variabili del dizionario con il nome
dell’intestazione della risposta come chiave e il valore dell’intestazione come valore del dizionario.
In Enterprise 11, la risposta di errore viene acquisita per impostazione predefinita. In Automation 360,
l'attivazione dell'opzione Acquisisci risposta di errore acquisisce gli errori e li aggiunge alla variabile
del dizionario delle risposte. Quando si esegue la migrazione di un bot Enterprise 11 a Automation 360,
l'opzione Acquisisci risposta di errore è abilitata per impostazione predefinita per acquisire la risposta di
errore del bot migrato.
The time-out value configured in Enterprise 11 to send REST request is migrated to Automation 360 as
part of global values (AARestTimeOut). The default time-out value is set as 60000 ms in Automation 360.
You can update this value if the REST Web Service is taking more time to receive a response.
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Consulta REST Web Service package on page 1777.

Esegui logica

Il comando Esegui logica viene migrato all'azione Esegui del pacchetto Task Bot in Automation 360.
Inoltre, Gestione degli errori con il comando Esegui logica viene migrata nel blocco Prova e Cattura.
• Applicabile dalla v.25: i bots Enterprise 11 o Enterprise 10 che utilizzano il comando Esegui logica

vengono migrati quando una Logic MetaBot di riferimento viene rinominata o ne viene cambiato il
percorso dopo la mappatura. Se una Logic MetaBot viene rinominata o ne viene cambiato il percorso
dopo la mappatura nei TaskBot, i TaskBot vengono migrati con il nuovo nome o percorso della Logic
MetaBot.
La modifica del percorso relativo si applica nei seguenti scenari:
• La Logic viene spostata da una cartella all'altra.
• La Logic viene spostata da una cartella principale del MetaBot a una sottocartella.
• La Logic viene spostata da una sottocartella a una cartella principale del MetaBot.
• La cartella che contiene la Logic viene rinominata.

• Bots che utilizzano il comando Esegui logica che trasferisce gli attributi Credential Vault da un TaskBot
a una logica MetaBot possono essere migrati a Automation 360. Il nome delle credenziali e il nome
dell'attributo vengono visualizzati nei campi della riga corrispondente del bot migrato.

• Se è stata eseguita la migrazione utilizzando il database Enterprise 11 ripristinato, viene creato un
locker equivalente in Automation 360 per le variabili delle credenziali utilizzate nel bot Enterprise 11.

• Ciò si applica da v23: i bots Enterprise 11 o Enterprise 10 che usano il comando Esegui Logica
sono autorizzati a trasferire variabili di tipo Credential Vault dal bot padre a una variabile di tipo non
Credential Vault del MetaBot. Tuttavia, in Automation 360, le variabili Credential Vault passano solo alle
variabili di tipo credenziale (e non alle variabili di tipo non Credential Vault) per una maggiore sicurezza.
Pertanto, il processo di migrazione converte prima la variabile di tipo Credential Vault nella variabile di
tipo stringa utilizzando l'azione Converti credenziali in stringa del pacchetto Credenziali in modo
che i bot migrati possano essere eseguiti con successo. La variabile stringa viene quindi assegnata a
una variabile temporanea che viene utilizzata come parametro di input nell'azione Attività > Esegui
per richiamare la Logic di MetaBot.

• I Bots che utilizzano variabili Credential Vault vengono trasferiti da una Logic di MetaBot a un'altra Logic
di MetaBot per il comando Avvia gestione errori > Esegui logica.

• Quando esegui un comando Avvia gestione errori > Esegui logica, puoi migrare un MetaBot con
una Logic (padre) che include una Logic (figlio) rinominata. Se una Logic figlio viene rinominata dopo
essere stata mappata alla Logic padre, la mappatura di questa Logic padre viene migrata con il nuovo
nome.

Scegli una delle opzioni seguenti per eseguire correttamente i bots migrati:
• Opzione 1: Trasferisci le variabili di tipo credenziale.

1. Crea una variabile di tipo di credenziale nei bots figli come variabili di input.
2. Nell'action Esegui del package Task Bot del bot padre, aggiorna i campi del valore di input per

utilizzare gli attributi Credential Vault per la variabile di tipo di credenziale creata per il bot figlio
(corrispondente alla logica di MetaBot).
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• Opzione 2: Trasferisci i valori delle credenziali come valore globale.
1. Crea il valore globale in Automation 360 per l'uso delle credenziali nel comando Esegui logica in

Enterprise 11.
2. Nell'action Esegui del package Task Bot del bot padre, aggiorna i campi del valore di input per

utilizzare i valori globali per la variabile di tipo di credenziale creata per il bot figlio (corrispondente
alla logica MetaBot).

Se non è stato utilizzato il database Enterprise 11 ripristinato durante l'installazione di Automation 360,
crea l'armadietto richiesto per le variabili delle credenziali utilizzate nel bot Enterprise 11 prima di eseguire i
passaggi precedenti.

Note:  Automation 360 fornisce una protezione avanzata consentendo di assegnare gli attributi Credential
Vault solo alle variabili del tipo di credenziale. Ciò limita la gestione non protetta degli attributi Credential
Vault che potrebbero essere stati assegnati a variabili di tipo non credenziale.

Run Script

Il comando Esegui script viene migrato all'azione Esegui script dell'azione Automazione legacy.
Quando usi il pacchetto Automazione legacy con l'azione Esegui script dopo la migrazione, potrebbero
verificarsi problemi in alcuni scenari; esamina quindi la causa per scoprire come risolvere il problema:
• Causa: Nel campo Esegui script > Parametri di input, se il valore dell'argomento (trasferito da

Stringa > Assegna azione) contiene virgolette doppie seguite da una barra rovesciata alla fine
dell'argomento e il valore della variabile contiene uno spazio, la stringa si interrompe nel punto in cui è
presente il primo spazio (ciò è dovuto a modifiche di aggiornamento in openJDK).

• Esempio: Considera il percorso di una cartella come valore dell'argomento che viene trasferito usando
l'azione Stringa > Assegna, "\\fwus129ns.ny.fw.gs.com\mahatb\home\My Documents\Test Adhoc Request
\". Quando migri il bot Enterprise 11 in Automation 360, questo singolo valore di argomento viene
considerato come quattro diversi valori di argomento in Automation 360, secondo quanto segue:
• \\fwus129ns.ny.fw.gs.com\mahatb\home\My
• Documents\Test
• Adhoc
• Request\

• Soluzione: Modifica il bot Enterprise 11 e rimuovi le doppie virgolette nel valore della variabile
nell'azione Stringa > Assegna.

SAP Integration

Questo comando viene migrato a Recorder package > Acquisisci action in Automation 360. Tutte le
proprietà dell’oggetto in Enterprise 11 bots sono mappate con le proprietà equivalenti nel botsmigrato.

Note:  Se il bot Enterprise 11 con il comando SAP Integration sta usando il SAP GUI 740 o versioni
precedenti, effettua gli ulteriori passaggi indicati nella macchina Bot Agent per eseguire correttamente il
bot migrato in Automation 360. Per ulteriori informazioni, consulta Failed to capture SAP application using
SAP GUI 740 (A-People login required).

If you run migrated bots with the SAP GUI option selected but the SAP GUI window is closed, an exception
error is displayed. This occurs because, the Recorder package uses the Window title during runtime and,
in Automation 360, SAP Integration is migrated to Recorder package.
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La tabella seguente fornisce un elenco di SAP oggetti e le operazioni che è possibile migrare a Automation
360.

Oggetto Azione

Casella di testo Imposta testo, Aggiungi testo, Clic con tasto
sinistro, Clic con tasto destro, Doppio clic

Casella combinata Seleziona elemento in base a testo, Seleziona
elemento in base a indice, Ottieni elementi totali,
Ottieni testo elemento selezionato, Ottieni chiave
elemento selezionato, Ottieni proprietà, Imposta
come attivo, Clic sinistro, Clic destro, Doppio clic

Casella di controllo Seleziona, Deseleziona, Attiva/Disattiva, Ottieni
stato, Ottieni proprietà, Imposta come attivo, Clic
sinistro, Clic destro, Doppio clic

Pulsante Clic, Ottieni proprietà, Clic sinistro, Clic destro,
Doppio clic

Pulsante di opzione Seleziona, Ottieni stato, Ottieni proprietà,
Imposta come attivo, Clic sinistro, Clic destro,
Doppio clic

Barra dei menu Seleziona elemento per testo, Ottieni proprietà,
Imposta come attivo, Clic sinistro, Clic destro,
Doppio clic

Struttura ad albero Ottieni proprietà, Imposta come attivo, Clic
sinistro, Clic destro, Doppio clic, Ottieni elementi
totali, Ottieni indice selezionato, Ottieni testo
selezionato, Seleziona elemento per indice,
Seleziona elemento per testo

Etichetta Clic, Ottieni proprietà, Imposta come attivo, Clic
sinistro, Clic destro, Doppio clic

Tabulazione Ottieni proprietà, Imposta come attivo, Clic
sinistro, Clic destro, Doppio clic, Ottieni elementi
totali, Ottieni indice selezionato, Ottieni testo
selezionato, Seleziona elemento per indice,
Seleziona elemento per testo

Il resto del controllo
(Include comandi quali: GuiMainWindow,
GuiBox, GuiUserArea, GuiTitlebar e
GuiStatusbar)

Ottieni proprietà, Imposta come attivo, Clic
sinistro, Clic destro, Doppio clic

La tabella seguente mostra le actions eseguite sull'oggetto della finestra principale e la loro actions
equivalente in Automation 360:

Enterprise 11 action action Automation 360 equivalente

Attiva finestra action Attiva del package Window.

Chiudi finestra action Chiudi del package Window.

Esegui script actions Aggiungi sessione SAP ed Esegui
funzione del package Legacy Automation.
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Enterprise 11 action action Automation 360 equivalente

Ingrandisci finestra action Ingrandisci del package Window

Ripristina finestra action Ripristina del package Window

I comandi SAP che supportano le funzioni BAPI in Enterprise 11 vengono migrati su azioni equivalenti della
BAPI SAP package in Automation 360.
La tabella seguente mostra i comandi Enterprise 11 e la loro azione equivalente in Automation 360:

Comando Enterprise 11 Azione Automation 360

Connetti SAP BAPI > Connetti
È necessario creare i valori globali JcoDllPath
e JcoJarPath. Aggiorna il valore globale
JcoJarPath con la posizione del pacchetto
del connettore SAP Java e JcoDllPath con la
posizione della DLL del connettore SAP Java.

Crea funzione SAP BAPI > Crea funzione

Comando Recupera dati con l'opzione Campo
selezionata

SAP BAPI > Ottieni campo

Comando Recupera dati con l'opzione Tabella
selezionata

SAP BAPI > Ottieni tabella

Comando Recupera dati con l'opzione Struttura
selezionata

SAP BAPI > Ottieni struttura

Comando Set Data quando l'opzione Campi,
Tabella, o Struttura è selezionata

SAP BAPI > Imposta campo

Richiama funzione SAP BAPI > Esegui funzione

Esegui il flusso di lavoro standard SAP BAPI > Esegui il flusso di lavoro
standard

Esegui flusso di lavoro personalizzato SAP BAPI > Esegui flusso di lavoro
personalizzato

Invia e-mail

In Enterprise 10/Enterprise 11, il comando Invia e-mail utilizza le impostazioni e-mail specifiche dell'utente
archiviate come attributi delle credenziali all'interno dell'armadietto di sistema. Quando il primo bot viene
migrato, creiamo un armadietto personalizzato denominato AAE_Email e aggiungiamo la credenziale
AAE_EmailSettings con gli attributi Nome utente e Password. Inoltre, vengono creati Valori globali per
gli attributi non credenziali, come Host del server, Porta, SSL e Autenticazione, che corrispondono alle
stesse Impostazioni e-mail. Enterprise 10/Enterprise 11 Le credenziali delle Impostazioni e-mail sono
suddivise in Variabili delle credenziali e Valori globali in Automation 360, pertanto durante il processo di
migrazione le impostazioni e-mail sono migrate come segue:

Impostazioni e-mail Enterprise
10/Enterprise 11

Automation 360 Impostazioni
e-mail

Automation 360 Tipo di
archiviazione

Host Valore globale della stringa del
tipo AAE_EmailSettings_host
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Impostazioni e-mail Enterprise
10/Enterprise 11

Automation 360 Impostazioni
e-mail

Automation 360 Tipo di
archiviazione

Porta Valore globale del numero del
tipo AAE_EmailSettings_port

Usa connessione sicura (SSL/
TLS)

Valore globale di tipo booleano
AAE_EmailSettings_ssl

Il mio server richiede
l’autenticazione

Valore globale di tipo booleano
AAE_EmailSettings_auth

Nome utente Attributo credenziali
nome utente all'interno
della credenziale
AAE_EmailSettings
assegnata all'armadietto
AAE_Email

Password Attributo credenziali password
all'interno della credenziale
AAE_EmailSettings
assegnata all'armadietto
AAE_Email

Servizi

Tutti i comandi di Servizi sono migrati ad azioni Automation 360 equivalenti del pacchetto Servizi. Non vi
è alcun cambiamento nel comportamento o nel nome dei comandi.

Servizio Web SOAP

Questo pacchetto si comporta allo stesso modo in Automation 360.
Se un servizio Web SOAP è configurato per chiamare le API REST, le migreremo all’operazione del
servizio Web REST, anziché all’operazione del servizio Web SOAP. In base alle operazioni XML aggiuntive,
aggiungiamo operazioni dal pacchetto XML, per garantire che il bot migrato fornisca lo stesso risultato del
bot legacy.
The time-out value configured in Enterprise 11 to send SOAP request is migrated to Automation 360 as
part of global values (AASoapTimeOut). The default time-out value is set as 60000 ms in Automation 360.
You can update this value if the SOAP Web Service is taking more time to receive a response.
Esempio di utilizzo dell'azione Servizio Web SOAP on page 2076
Enterprise 11 fornisce diverse opzioni per selezionare il Tipo di URI per l'esecuzione, ad esempio
Predefinito, Statico e Dinamico. Tuttavia, in Automation 360, non è disponibile alcuna opzione per
selezionare il tipo di URI per l'esecuzione. I tipi di URI Enterprise 11 vengono migrati in Automation 360
come segue:
• Predefinito e Statico: Se il bot Enterprise 11 viene configurato con il tipo di URI Predefinito o

Statico, esso viene migrato come Statico e il campo Indirizzo posizione viene automaticamente
popolato.

• Dinamico: Se il bot Enterprise 11 viene configurato con il tipo di URI Dinamico, esso viene migrato
come Dinamico e il campo Indirizzo posizione rimane vuoto.

Consulta SOAP Web Service package on page 1880.
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Operazione stringa

Il comando Enterprise 11 o Enterprise 10 String Operation è migrato al actions equivalente di String
package.
La tabella seguente mostra i comandi String Operation e il loro equivalente actions in Automation 360.

Comandi Enterprise 11 o Enterprise 10 actions e packages Automation 360 equivalenti

Prima-Dopo Estrai

Confronta Confronta

Trova Trova

Lunghezza Lunghezza

Minuscolo Minuscolo

Sostituisci Sostituisci

Inverti Inverti

Dividi Dividi

Estrai sottostringa Estrai sottostringa

Taglia Taglia

Maiuscolo Maiuscolo

In Enterprise 11, both carriage return (CR) and newline (LF) were enumerated to calculate the total length
of String Operation. However, in Automation 360, only newline (LF) is considered for the length of String
Operation. Hence, the length count in the resulting output in Automation 360 is lesser.
Enterprise 11 bots può utilizzare espressioni regolari nei comandi Trova e Sostituisci per cercare la
stringa su cui si desidera eseguire un'operazione. Anche il actions equivalente in Automation 360 può
utilizzare espressioni regolari nei comandi per cercare la stringa su cui si desidera eseguire un’operazione.
In Enterprise 11, il sistema prende in considerazione il carattere di nuova riga (/n) utilizzato nella variabile
quando si utilizzano i comandi Trova e Sostituisci. Tuttavia, in Automation 360, il sistema non considera
il carattere di nuova riga quando si utilizzano i comandi Trova e Sostituisci.
Quando migri un bot in Automation 360 con l'operazione di stringa impostata su Prima o Dopo, l'output
viene recuperato e l'operazione viene eseguita correttamente. L'output corrispondente viene visualizzato
anche se non sono presenti caratteri prima della stringa abbinata. In Enterprise 11, bots con Prima o
Dopo non recuperano correttamente l'output, recuperando quindi la stringa sorgente stessa. Se non sono
presenti caratteri prima della stringa abbinata, viene visualizzato l'output senza alcuna corrispondenza
trovata.
Esempio:
Azione Trascina prima/dopo → (Input: [Sorgente = (ABCZ)] → [Prima = Z] →
[assegna a prompt-assignment] → Output: Vuoto("")

Azione Trascina prima/dopo → (Input: [Sorgente = (ZABC)] → [Dopo = Z] →
[assegna a prompt-assignment] → Output: ZABC

Sistema

Le operazioni Blocca computer, Disconnetti, Riavvia e Spegni sono migrate alle azioni equivalenti del
pacchetto Sistema in Automation 360.
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Consulta System package on page 1891.

Attività

La tabella seguente mostra i diversi comandi migrati alle rispettive azioni del pacchetto Automation 360
Task Bot.

Comandi Enterprise 11 o Enterprise
10

actions e packages Automation 360 equivalenti

Metti in pausa Metti in pausa

Sospendi attività Sospendi

Esegui attività Esegui. L'output restituito dai bots figlio viene mappato alla
rispettiva variabile nei bots padre.

Emulatore di terminale

Le azioni Invia testo e Imposta campo per Automation 360 non supportano la crittografia del testo. Si
consiglia di utilizzare Credential Vault invece del testo normale.
In Enterprise 11 e in Automation 360:
• I Bots che utilizzano il seguente modello di terminale possono essere migrati a Automation 360:

• Modello VT 220 del terminale Serie VT
• Modelli di terminali IBM 5555 B01 e C01 del tipo TN 5250

• Una sessione (utilizzata per stabilire una connessione con il server terminale) può essere condivisa tra il
padre bot e un figlio bot. È possibile concludere una sessione dal figlio bot invece che dal padre bot.

• È possibile utilizzare il terminale Predefinito in bots per il tipo di terminale VT100.
• I Bots che inviano testo giapponese utilizzando il comando Invia testo in Enterprise 11 con l'opzione

DBCS dall'elenco Codifica e l'opzione Giapponese Maiusc-JIS (932) dall'elenco PaginaCodice
selezionato nel comando Connetti possono essere migrati in Automation 360.

• Applies only to v.24 and earlier: Nel Terminal Emulator, quando fai clic manualmente sul tasto nella
tastiera, la tastiera principale Invio è identificata come {enter} in Enterprise 11, mentre in Automation
360 è identificata come {return}.

Automation 360 non supporta la tecnologia legacy e per impostazione predefinita supporta tutte le
funzionalità di Advance Technology di Enterprise 10/Enterprise 11 bots.
Il valore massimo dell’indice in Automation 360 è 99999. Il processo di migrazione aggiorna
automaticamente il valore di Indice campo nell'azione Imposta campo su 99999, per soddisfare
la limitazione sul valore massimo. Se il valore dell’indice è superiore a 99999 e viene utilizzato in una
variabile, è necessario modificarlo manualmente.
La funzionalità SSHI non è ancora supportata in Automation 360.
L'azione Cerca campo consente di cercare l'indice o il nome del campo utilizzando un testo.
I Bots creati in Enterprise 11 non mostrano più il testo Tentativo in corso... dopo che i bots sono
stati migrati a Automation 360.
Consulta Terminal Emulator package on page 1902.
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Funzionamento variabile

Di seguito sono riportate le operazioni quando un valore viene assegnato alla variabile:

Variabili di tipo Valore La funzionalità per questo comando è stata
suddivisa in più pacchetti in Automation 360.
In Enterprise 10/Enterprise 11, questo comando
eseguiva operazioni di assegnazione per tutti i tipi di
dati supportati. Automation 360 ha creato un'azione
Assegna dedicata per ciascun tipo di dati. Il
processo di migrazione gestisce la mappatura
dei pacchetti corretti e dell’operazione in base
all’assegnazione eseguita dalla rispettiva operazione
variabile.
Per i bots Enterprise 11 che utilizzano l'opzione
Configurazione decimale, l'action A stringa del
Number package viene aggiunta ai bots migrati. In
Enterprise 11, il sistema arrotonda il valore in base
al valore specificato nel campo Configurazione
decimale. Ad esempio, se il valore assegnato alla
variabile è 13,456 e il valore specificato nel campo
Configurazione decimale è 2, il sistema esegue
l'arrotondamento del valore in Enterprise 11 a
13,46. In Automation 360, il valore viene tagliato
invece che arrotondato. Ad esempio, il valore
13,456 verrà convertito in 13,45 in Automation 360.

Variabili tipo Elenco Le operazioni che interessano le assegnazioni di
elenco sono migrate a Imposta elemento del
pacchetto Elenco. Se l’operazione ha un valore
fisso, il sistema crea una variabile temporanea e
vi memorizza il valore fisso. Puoi quindi utilizzare
questa variabile temporanea nell'azione Assegna
del pacchetto Elenco per salvarla.

Variabili di tipo Matrice Le operazioni che interessano l'assegnazione della
matrice sono migrate all'azione Imposta valore di
una singola cella nel pacchetto Tabella dati per
impostare un valore per righe e colonne specifiche.

Variabili di tipo Dizionario Le operazioni che interessano l'assegnazione
del dizionario sono migrate all'azione Metti del
pacchetto Dizionario per impostare il valore per
una chiave specifica. Se la chiave è la combinazione
di una variabile e di un valore fisso (ad esempio
$Dictionary(key-$id$)$), viene aggiunto il
pacchetto Stringa > azione Assegna per ottenere
la chiave effettiva.

Variabile di sistema $Date$ Il comando Operazione variabile Enterprise
10/Enterprise 11 che utilizza la variabile di sistema
$Date$ è migrato a Automation 360 con l'aggiunta
di nuove operazioni date in base all'operazione
eseguita utilizzando $Date$. Il processo di
migrazione converte anche il valore della data in
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un formato di stringa predefinito (mm/dd/yyyy
 HH:mm:ss).
Variabile casuale del sottotipo Stringa: La
migrazione e la mappatura vengono eseguite
direttamente.

Di seguito sono riportate le operazioni delle variabili quando un valore della variabile viene
reinizializzato:

Variabile elenco Per il comando Operazioni variabili che
reinizializza la variabile elenco in Enterprise
10/Enterprise 11, il processo di migrazione crea
una variabile elenco temporanea con nuovi valori
e la assegna alla variabile elenco di destinazione in
Automation 360.

Variabile Elenco dichiarata leggendo un file di
testo

Questo comando viene migrato all'action
Importa elenco da file di testo nel package
Automazione legacy.

Note:  In Automation 360, il bot rileva un errore se
il file di origine è vuoto o non contiene una chiave
per inizializzare la variabile elenco, a differenza di
Enterprise 10 o Enterprise 11.

Variabile Matrice dichiarata leggendo un file
di testo

Il tipo di variabile Matrice viene migrato come tipo
di variabile Tabella in Automation 360. Il sistema
utilizza il pacchetto CSV/TXT per leggere e caricare
i rispettivi dati nella variabile tabella nel bot.

Variabile dizionario Il processo di migrazione crea una variabile
dizionario temporanea per archiviare tutte le chiavi
e i valori. Successivamente, il sistema utilizza il
pacchetto Dizionario > azione Assegna per
aggiornare la variabile di destinazione con le chiavi
e i valori della variabile dizionario temporanea.

Variabile Dizionario dichiarata leggendo un
file di testo

Il processo di migrazione affronta questo caso
d'uso aggiungendo operazioni per leggere il file CSV
utilizzando il pacchetto CSV/Testo e archiviando
i dati in una variabile tabella. Successivamente,
aggiunge operazioni per eseguire un ciclo sulla
variabile tabella, e utilizza il pacchetto Dizionario
azione > Metti per aggiungere chiavi e valori nella
variabile dizionario.

Variabile Matrice dichiarata leggendo un file
Excel/CSV

Il processo di migrazione affronta questo caso
d’uso migrando il tipo di variabile Matrice come tipo
di variabile Tabella in Automation 360. Il sistema
aggiunge le azioni Apri, Ottieni più celle e
Chiudi del pacchetto Excel avanzato e popola la
variabile tabella.

Di seguito sono riportate le operazioni delle variabili quando un valore della variabile di sistema viene
ripristinato:

Funzionamento variabili (reset delle variabili
di sistema)

Le seguenti variabili di sistema sono migrate come
variabili definite dall’utente in Automation 360. Il
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sistema aggiunge una rispettiva operazione per
cancellare il valore della variabile equivalente creata
in Automation 360.
• Cc e-mail
• E-mail da
• Messaggio e-mail
• Data di ricezione e-mail
• Ora di ricezione e-mail
• Oggetto dell'e-mail
• E-mail a
• Descrizione dell'errore
• Numero di riga dell'errore

Attendi

Attendi finestra e Attendi modifica schermata in Automation 360 generano un errore di eccezione
se la rispettiva finestra non viene aperta/chiusa nel tempo specificato o se la schermata non viene trovata
nel tempo specificato. In questi casi, il sistema aggiunge il blocco Prova e Cattura se il comando è stato
configurato per arrestare il bot e aggiunge l'azione Arresta attività nel blocco Cattura. Ciò serve a
garantire che il comportamento di esecuzione di bots migrato sia lo stesso di Enterprise 10/Enterprise 11.
Poiché stiamo migrando i comandi con l'operazione Arresta bot incapsulata con il blocco Prova e Cattura
in Automation 360, il bot si arresta anche se l'azione non riesce per un altro motivo. Durante il processo
di migrazione, l'azione Arresta bot aggiunge anche ulteriori gestori di errori nei bots migrati quando
l'opzione Arresta attività è selezionata.
L'azione Attendi finestra può avere valori negativi per le coordinate non supportate in Automation 360. I
valori negativi vengono modificati in 0 durante il processo di migrazione.

Registratore web

Tutti i comandi (tranne quelli indicati di seguito in modo esplicito) del Registratore Web vengono
migrati alle rispettive azioni all'interno del pacchetto Automazione legacy in Automation 360. Il
pacchetto Automazione legacy garantisce che i bots migrati forniscano gli stessi risultati di Enterprise
10/Enterprise 11. Tuttavia, non è consigliabile utilizzare il pacchetto Automazione legacy per il nuovo
sviluppo.
Trova link interrotti viene migrato al pacchetto Browser > Trova link interrotti. Inoltre, Enterprise
10/Enterprise 11 dispone delle opzioni "Trova timeout link interrotti" e "Trova link interrotti" in Strumenti >
Opzioni. Automation 360 presenta queste opzioni come parte dell'azione, il timeout passa per impostazione
predefinita a 10 secondi e il numero di thread paralleli per impostazione predefinita è 10.
Scarica file viene migrato al pacchetto Browser > Scarica file.
Durante il processo di migrazione, l'azione Estrai tabella aggiunge ulteriori gestori di errore nei bots
migrati quando la casella di controllo In caso di errore prosegui con l'azione successiva è abilitata.

Azione Finestra

Tutti i comandi di Windows Actions vengono migrati all’equivalente actions di Window package in
Automation 360.
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I bots Enterprise 11 possono utilizzare espressioni regolari nei comandi Ottieni titolo finestra attiva,
Attiva finestra, Ingrandisci finestra, Riduci finestra a icona, Chiudi finestra e Ridimensiona
finestra, per cercare la finestra su cui desideri eseguire un'operazione. Anche il actions equivalente in
Automation 360 può utilizzare espressioni regolari nei comandi per cercare la finestra su cui si desidera
eseguire un’operazione.
Consulta Window package on page 1929.

XML

Tutti i comandi di XML (XML) vengono migrati ad azioni equivalenti del pacchetto XML in Automation 360.
I nomi di comando seguenti sono stati modificati:

Enterprise 10/Enterprise 11 Automation 360

Termina sessione XML | Termina sessione

Avvia sessione XML Inizia sessione

Elimina nodo/attributo Elimina nodo

Aggiorna nodo/attributo Aggiorna nodo

Ottieni nodi con l'opzione "Nodi singoli" attivata Operazione Ottieni nodo singolo

Azione Ottieni nodi con l'opzione "Nodi multipli" attivata Operazione Ottieni nodi multipli

In Enterprise 11, quando imposti il comando XML su Ottieni nodi con l'opzione Più nodi selezionata,
l'opzione Espressione XPath restituisce solo l'ultimo elemento dell'espressione corrispondente. In
Automation 360, l'Espressione XPath restituisce tutti gli elementi corrispondenti.
I bots Enterprise 11 che estraggono nodi che contengono gli spazi dei nomi da un file XML possono essere
migrati in Automation 360. Se si aggiunge uno spazio dei nomi a un nodo in un file XML, è necessario
salvare e ricaricare il file XML per riflettere le modifiche.
Consulta XML package on page 1939.

Mappatura delle variabili per la migrazione
Nella migrazione, alcune variabili si mappano direttamente dalle versioni precedenti del prodotto a
Automation 360 mentre altre si comportano in modo diverso o contengono modifiche di configurazione.

Note:  In Enterprise 11, if a bot used a variable that was followed by a space and a string that began with
a dollar sign character ($) and enclosed in parentheses, brackets, or braces, after migration, the variable
field encounters an error. The error occurs because, in Automation 360, two dollar sign characters ($$)
are required in a string to display the dollar sign. To fix this error, add another dollar sign to the string. For
example, if you are using the prompt-assignment variable to display a string followed by $5 [$Prompt-
Assignment$ ($5)], after migration, the variable field displays an error. To fix the error, edit the variable
field to add another dollar sign, as follows: [$Prompt-Assignment$ ($$5)].

Variabili definite dall’utente

In Automation 360, tutte le variabili definite in bots vengono create come Usa come input o Usa come
output durante la migrazione per scambiare valori tra bots padre e bots figlio.
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Se le variabili sono mappate tra un bot padre e un bot figlio in Enterprise 11 e alcune delle variabili
mappate non sono disponibili né nel bot padre né nel bot figlio, il processo di migrazione rimuove queste
variabili. Il processo di migrazione rimuove tali variabili per i bots figlio che vengono migrati insieme al bots
padre e per i bots figlio che sono già migrati.
For information about the list of variables supported, see Supporto della variabili on page 732.
Esamina in che modo avviene la migrazione delle seguenti variabili definite dall'utente.
• Array
• Dizionario
• Elenco
• Casuale
• Valore

Array

In questa sezione viene illustrato come avviene la migrazione della variabile Array in Automation 360. In
alcuni casi, potrebbe essere necessario eseguire alcune azioni o assicurarsi di eseguire alcune operazioni
prima o dopo la migrazione.

Sottotipo "Valore" Le variabili con questo sottotipo vengono migrate
a Tabella con tutti i valori delle colonne come
Stringa.

Sottotipo "Leggi da file di testo" Le variabili con questo sottotipo vengono migrate
a Tabella con tutti i valori delle colonne come
Stringa.
Le seguenti operazioni vengono aggiunte come
parte della migrazione per configurare i dati nella
variabile:

Azioni Automation 360 Funzione

CSV/TXT > Apri Apre il file per la
lettura.

CSV/TXT > Leggi Restituisce il valore
nella variabile Tabella.

CSV/TXT > Chiudi Chiude il file.

Sottotipo "Leggi da database" Le variabili con questo sottotipo vengono migrate
al pacchetto Tabella con tutti i valori delle colonne
come Stringa.
Le seguenti operazioni vengono aggiunte come
parte della migrazione per configurare i dati nella
variabile:

Azioni Automation 360 Funzione

Database > Connetti Aggiunge l'azione
Connetti con la
stringa di connessione
corrispondente.
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Azioni Automation 360 Funzione

Database > Esporta
nella tabella dati

Aggiunge l'azione
Esporta nella tabella
dati per restituire i
risultati alla variabile
della tabella dati.

Database >
Disconnetti

Aggiunge l'azione
Disconnetti per
disconnettere il
database.

Vedere anche: Database package on page 1449.

Sottotipo "Leggi da file Excel/CSV" Le variabili con questo sottotipo vengono migrate
a Tabella con tutti i valori delle colonne come
Stringa.
Le seguenti operazioni vengono aggiunte come
parte della migrazione per configurare i dati nella
variabile:

Azioni Automation 360 Funzione

Excel avanzato >
Apri

Apre il file per la
lettura.

Excel avanzato >
Ottieni più celle

Restituisce il valore
della variabile Tabella
se nella dichiarazione
delle variabili viene
scelta l'opzione Tutte
le celle o Intervallo.

Excel avanzato >
Leggi ora

Restituisce il valore
della variabile Tabella
se nella dichiarazione
delle variabili viene
scelta l'opzione Riga
intera.

Excel avanzato >
Leggi colonna

Restituisce la variabile
Tabella se nella
dichiarazione delle
variabili viene scelta
l'opzione Colonna
intera.
Inoltre, il pacchetto
Assegna elenco a
tabella di dati elenco
viene utilizzato per
memorizzare il valore
restituito nella variabile.

Excel avanzato >
Chiudi

Chiude il file.
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Important:  In Automation 360, una variabile di
tabella vuota restituisce un errore di runtime. Se il
bot migrato contiene una variabile di tabella vuota,
devi risolvere il problema in Automation 360.

Variabile di array: tipi di input accettati dalla
funzione DLL

Quando il sistema passa una variabile Array da una
Enterprise 11 bot a una funzione DLL di un tipo
diverso, la funzione DLL accetta come tipi di input i
seguenti:
• UInt16[], Int16[], Int32[], Int64[], Int[], Char[],

Single[], Decimal[], Float[], Double[], Boolean[],
bool[], Byte[], String[] e Datetime[]

• UInt16, Int16, Int32, Int64, Int, Char, Single,
Decimal, Float, Double, Boolean, bool, Byte,
String e Datetime

• List<UInt16>, List<Int16>, List<Int32>,
List<Int64>, List<Int>, List<Char>,
List<Single>, List<Decimal>, List<Float>,
List<Double>List<Boolean>, List<bool>,
List<Byte>, List<String>, List<Date-Time>

• UInt16[,], Int16[,], Int32[,], Int64[,], Int[,],
Char[,], Single[,], Decimal[,], Float[,], Double[,],
Boolean[,], bool[,], Byte[,], String[,] e
Datetime[,]

Ulteriori informazioni Puoi eseguire la migrazione dei bots Enterprise 10 o
Enterprise 11 che includono variabili Array.
Di seguito sono riportate alcune differenze di
comportamento chiave:
• La posizione dell'indice inizia con 1 in Enterprise

10 e Enterprise 11, mentre la posizione
dell'indice inizia con 0 in Automation 360. For
example, $arrayVariable(1,1)$ becomes
$arrayVariable[0][0]$

• Se un array ha 10 righe/colonne e un loop è
in esecuzione più di 10 volte, allora Enterprise
10/Enterprise 11 restituisce il nome della
variabile di array con la posizione di indice.

• In Enterprise 11, if you pass a constant string
value to an array index in any command (for
example $array(field1), where field1 is not
a variable), the value is used as is (for example,
$array(field1)). Dopo la migrazione di bot
a Automation 360, tuttavia, se il comando ha un
valore senza variabile, viene restituito un errore
in fase di compilazione.

• In Enterprise 11, if you pass an array variable
without any index (for example "$array$",
"$array()$", where index is missing), the
value is used as is (for example, "$array$",
 "$array()$"). However, after the bot is
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migrated to Automation 360, a compile time
error occurs.

Important:  Se si utilizza un indice non valido per
accedere alle matrici in Enterprise 11, assicurati
di risolvere l'errore del bot prima o dopo la
migrazione.

Dizionario

In questa sezione viene illustrato come avviene la migrazione della variabile Dizionario in Automation
360. In alcuni casi, potrebbe essere necessario eseguire alcune azioni o assicurarsi di eseguire alcune
operazioni prima o dopo la migrazione.

Esegui logica In Enterprise 11, when you perform a Run Logic
operation, you can select a specific key from the
Dictionary variable and map it to the required value
variable.
In Automation 360, you can only map variables
directly and cannot map a Dictionary(key) variable
to a string.

Sottotipo "Valore" Il sistema migra queste variabili al tipo Dizionario
con il sottotipo Stringa in Automation 360.

Sottotipo "Leggi da file CSV" Il processo di migrazione aggiunge azioni per
leggere il file CSV utilizzando il pacchetto CSV/
Testo e archivia i dati in una variabile di tabella.
Il processo aggiunge inoltre azioni per eseguire
un ciclo sulla variabile Tabella e utilizza l'azione
Inserisci del pacchetto Dizionario per aggiungere
la chiave e i valori nella variabile Dizionario.

Variabile dizionario: tipi di input accettati
dalla funzione DLL

Quando il sistema passa una variabile del dizionario
da una Enterprise 11 bot a una funzione DLL di un
tipo diverso, la funzione DLL accetta come tipi di
input i seguenti: UInt16, Int16, Int32, Int64, Int,
Char, Single, Decimal, Float, Double, Boolean, bool,
Byte, String e Datetime.

Ulteriori informazioni Puoi eseguire la migrazione dei bots Enterprise 10 o
Enterprise 11 che includono variabili Dizionario.
La tabella seguente descrive alcune differenze di
comportamento delle chiavi e il loro funzionamento
in Automation 360:
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Comportamento
di Enterprise 10 o
Enterprise 11

Comportamento di
Automation 360

Le chiavi del dizionario
non distinguono tra
maiuscole e minuscole
in Enterprise 10 o
Enterprise 11.

Le chiavi del dizionario
distinguono tra
maiuscole e minuscole
in Automation 360.
Per mantenere la
resilienza di esecuzione
bot, il processo di
migrazione converte
tutte le chiavi del
dizionario in valori
minuscoli. Per ottenere
il nome della chiave in
caratteri in minuscolo
viene usata la stringa
Minuscolo se una
variabile viene utilizzata
come chiave del
dizionario.

Elenco

In questa sezione viene illustrato come avviene la migrazione di Elenco in Automation 360. In alcuni casi,
potrebbe essere necessario eseguire alcune azioni o assicurarsi di eseguire alcune operazioni prima o dopo
la migrazione.

Sottotipo "Valore" Queste variabili vengono migrate a Elenco con
sottotipo Stringa.

Sottotipo Array Queste variabili vengono migrate a Elenco con
sottotipo Stringa.

Sottotipo "Lettura da file di testo" Quando viene richiamata una variabile dichiarata
leggendo un file, l'azione Importa elenco dal file
di testo del pacchetto Automazione legacy viene
aggiunta sopra l'azione in fase di migrazione.

Dichiarato come "Rendi casuale" La variabile Elenco può essere dichiarata come
Rendi casuale in Enterprise 10 o Enterprise 11
per restituire un elemento casuale dall'elenco. Il
processo di migrazione aggiunge la nuova azione
Dimensioni al pacchetto Elenco per ottenere
la dimensione dell'elenco e aggiunge l'azione
Assegna un numero casuale al pacchetto
Numero per trovare la posizione casuale e
utilizzarla per ottenere una voce di elenco casuale.

Important:  In Automation 360, una variabile
di elenco vuota utilizzata al di fuori di un loop
restituisce un errore di runtime. Se il bot migrato
soddisfa questi criteri, devi risolvere il problema
nell'ambiente Automation 360.
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Ulteriori informazioni • In Enterprise 10 e Enterprise 11, Elenco è
accessibile senza specificare alcun indice. In
Automation 360, devi specificare il rispettivo
indice per recuperare il valore specifico
dall'elenco.
Esempio: È possibile accedere alle variabili
Elenco tramite l'indice nel modo seguente:
$listVariable[0]$

Qui, 0 rappresenta il primo valore nell'elenco.
• La posizione dell'indice inizia con 1 in Enterprise

10 o Enterprise 11, mentre inizia con 0 in
Automation 360.

• Comportamento di Enterprise 11: In
Enterprise 11, quando viene utilizzato un elenco
con un indice fisso, il sistema restituisce il valore
disponibile nel primo indice dell'elenco.
Esempio: For example, consider that you have
a list with values 1, 2, 3, and 4, and you use
$IntList(3)$ to retrieve the value in the third
index position of the list. Il sistema restituisce
il valore disponibile nella prima posizione indice
dell’elenco (1) invece della posizione indice
specificata (3).
Comportamento di Automation 360: In
Automation 360, il sistema restituisce il valore
disponibile nella posizione indice specificata (per
l'esempio precedente, restituisce 3).
Behavior of migrated bots:Enterprise 11
bots che utilizzano tali espressioni con indici fissi
nell'elenco e vengono migrate per Automation
360 restituiscono il valore disponibile nella
posizione indice specificata.

• Se un elenco ha 10 elementi e un loop è in
esecuzione per più di 10 volte, Enterprise
10 o Enterprise 11 restituisce il primo valore
dell'elenco dopo la 10a iterazione.

Variabile Elenco: tipi di input accettati dalla
funzione DLL

Quando il sistema passa una variabile Elenco da
una Enterprise 11 bot a una funzione DLL di un tipo
diverso, la funzione DLL accetta come tipi di input i
seguenti:
• UInt16[], Int16[], Int32[], Int64[], Int[], Char[],

Single[], Decimal[], Float[], Double[], Boolean[],
bool[], Byte[], String[] e Datetime[]

• UInt16, Int16, Int32, Int64, Int, Char, Single,
Decimal, Float, Double, Boolean, bool, Byte,
String e Datetime

• List<UInt16>, List<Int16>, List<Int32>,
List<Int64>, List<Int>, List<Char>,
List<Single>, List<Decimal>, List<Float>,
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List<Double>List<Boolean>, List<bool>,
List<Byte>, List<String>, List<Date-Time>

• UInt16[,], Int16[,], Int32[,], Int64[,], Int[,],
Char[,], Single[,], Decimal[,], Float[,], Double[,],
Boolean[,], bool[,], Byte[,], String[,] e
Datetime[,]
Vedere anche: List package on page 1675.

Casuale

In questa sezione viene illustrato come avviene la migrazione della variabile Casuale in Automation 360.
In alcuni casi, potrebbe essere necessario eseguire alcune azioni o assicurarsi di eseguire alcune operazioni
prima o dopo la migrazione.

Sottotipo "Stringa casuale" Per la variabile Casuale del sottotipo Stringa, il
processo di migrazione aggiunge l'azione Genera
stringa casuale del pacchetto Stringa per
generare una stringa casuale al di sopra della
condizione If e assegna il valore alla rispettiva
variabile migrata in Automation 360

Sottotipo "Numero casuale" Quando è presente una variabile Casuale del
sottotipo Numero, il processo di migrazione
aggiunge l'azione Assegna un numero casuale
del pacchetto Numero per generare una stringa
casuale al di sopra della condizione If e assegna il
valore alla rispettiva variabile migrata in Automation
360.

Valore

In questa sezione viene illustrato come avviene la migrazione di Valore in Automation 360. In alcuni casi,
potrebbe essere necessario eseguire alcune azioni o assicurarsi di eseguire alcune operazioni prima o dopo
la migrazione.

Sottotipo "Valore" Queste variabili vengono sempre migrate come
Stringa in Automation 360, anche se contengono
valori numerici, booleani o data/ora. Le espressioni
vengono utilizzate in Automation 360 per convertire
una stringa in altri tipi, se necessario.

Sottotipo "Leggi da file di testo" To maintain the integrity of bot execution during
migration, where a variable that is declared by
reading a file is called, the Import string from
text file action of the String package is added just
above the action being migrated.
If Enterprise 11 bots contain variables that read
values from a text file, then these bots are migrated
using the Read variable action.
If a specific variable does not exist in the text file,
or if the specific variable is reading a value from
a file that does not exist, then Automation 360
generates an exception error.
After migration, when you run the bot that contains
the Read from file variable, the reading occurs
only once in the Read variables action at the
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start of the bot running process. If the file that the
variable is trying to read gets updated while the
bot is running, then the Read file variable is not
refreshed.
.

Ulteriori informazioni Bots che utilizzano variabili di tipo valore all'interno
di una variabile possono essere migrati in
Automation 360. Per i bots Enterprise 11 che
utilizzano una variabile all'interno di una variabile
nel comando Insert Keystrokes, action Calcola
valore del package String viene aggiunta nel bot
migrato

Vedere anche: String package on page 1881 | Number package on page 1695 | Boolean package on page
1421 | Datetime package on page 1471

Variabili di sistema

In alcuni casi, variabili di sistema quali Numero di riga dell'errore, Descrizione dell'errore, Nome del sistema
operativo restituiscono un valore diverso in Automation 360. I Bots che utilizzano queste variabili in un
processo decisionale o in un'operazione di stringa richiedono una revisione dopo la migrazione.
Alcune variabili di sistema utilizzate all'interno di un loop sono variabili definite dall'utente nel loop dopo la
migrazione. In alcuni casi, la variabile definita dall'utente potrebbe richiedere una qualche configurazione
nel bot migrato.
Alcune variabili di sistema vengono migrate come azioni in Automation 360. Queste operazioni vengono
aggiunte appena sopra l'azione che sta utilizzando queste variabili.
Se una variabile è definita nella posizione di indice per le seguenti variabili di sistema, potresti dover
risolvere i bots migrati perché il processo di migrazione non è stato in grado di determinare se la variabile
contiene un indice o un nome di colonna. Se non lo correggi, bot potrebbe restituire un errore di runtime
Chiave non trovata nel record. Il processo di migrazione tratta il valore di una variabile come
nome, ma se si tratta di un indice, è necessario modificarlo di conseguenza.
• $Filedata Column$
• $Dataset Column$
• $XML Data Node$
• $Excel Column$

La tabella seguente fornisce informazioni sulle varie variabili di sistema e su come vengono migrate in
Automation 360. Alcune variabili fanno parte delle azioni, alcune sono diventate azioni e altre sono note
come variabili di sistema, ma hanno modifiche alla sintassi.

Note:  Migrated bots do not preserve data outside of the loop for the following system variables:
• $FolderName$
• $FileName$
• $Extenstion$

Variabile di sistema Come avviene la migrazione a Automation 360

$Day$ Becomes $System:Day.Number:toString$ in Automation 360
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Variabile di sistema Come avviene la migrazione a Automation 360

$FileName After migration, the system automatically creates this variable according
to the Automation 360 naming convention, to run the migrated bots
successfully.

$Error Description After migration, the system automatically creates this variable according
to the Automation 360 naming convention, to run the migrated bots
successfully.

$Error Line Number$ After migration, the system automatically creates this variable according
to the Automation 360 naming convention, to run the migrated bots
successfully.

$Extension$ After migration, the system automatically creates this variable according
to the Automation 360 naming convention, to run the migrated bots
successfully.

$Folder Name$ After migration, the system automatically creates this variable according
to the Automation 360 naming convention, to run the migrated bots
successfully.

$Month$ Becomes $System:Month.Number:toString$ in Automation 360

$Year$ Becomes $System:Year.Number:toString$ in Automation 360

$Date$ Becomes $System:Date$ in Automation 360
Il formato della data impostato per la variabile nel bot Enterprise 11 o
Enterprise 10 è memorizzato nel valore globale AADefaultDateFormat.

$Hour$ Becomes $System:Hour.Number:toString$ in Automation 360

$Minute$ Becomes $System:Minute.Number:toString$ in Automation 360

$Clipboard$ Becomes $System:Clipboard$ in Automation 360

$Machine$ Becomes $System:Machine$ in Automation 360

$MiliSecond$ Becomes $System:MiliSecond.Number:toString$ in Automation 360

$ArrayColumns($arrayVariable
$)$

Becomes an expression in Automation 360:
$arrayVariable.DataTable:columnCount$

$ArrayRows($arrayVariable
$)$

Becomes an expression in Automation 360:
$arrayVariable.DataTable:rowCount$

$AAControlRoom$ Becomes $System:AAControlRoom$ in Automation 360

$RAMUsage$ Becomes $System:RAMUsage$ in Automation 360

$TotalRAM$ Becomes $System:TotalRAM$ in Automation 360

$OSName$ Enterprise 10 o Enterprise 11 restituisce il valore di Microsoft Windows 10
Pro a 64 bit. In Automation 360, this variable becomes $System:OSName$
and returns the Windows 10 64-bit.

$CPUUsage$ Becomes $System:CPUUSage$ in Automation 360
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Variabile di sistema Come avviene la migrazione a Automation 360

$Counter$ Questa variabile di sistema è obsoleta in Automation 360. Il processo di
migrazione crea un tipo di variabile definito dall'utente Numero e modifica il
bot per garantire che fornisca lo stesso output del bot 11.x.
Se hai utilizzato la variabile $Counter$ in un loop, il processo di migrazione
sostituisce la variabile con la variabile $Condition-Counter$ nella bot migrata
e imposta il valore su 1.

$Dataset Column$ Questa variabile di sistema fa ora parte dell'iteratore Per ogni riga in un
set di dati di query SQL in Ciclo. The system creates a new variable in the
loop and uses it inside the loop wherever $Dataset Column$ is present.
Se la variabile viene utilizzata all'esterno di un loop, viene convertita in una
variabile definita dall'utente di tipo record e assegnata a un'azione Record
che consente di assegnare il valore della variabile record di origine alla
variabile record di destinazione. Pertanto, quando si eseguono i bots migrati
che contengono questa variabile, vengono visualizzati i dati dell'ultima riga.

$Excel Column$ Questa variabile di sistema fa ora parte dell'iteratore Per ogni riga nel
foglio di lavoro in Loop. The system creates a new variable in the loop and
uses it inside the loop wherever $Excel Column$ is present.
Se la variabile viene utilizzata all'esterno di un loop, viene convertita in una
variabile definita dall'utente di tipo record e assegnata a un'azione Record
che consente di assegnare il valore della variabile record di origine alla
variabile record di destinazione. Pertanto, quando si eseguono i bots migrati
che contengono questa variabile, vengono visualizzati i dati dell'ultima riga.

$Extension$ e
$FileName$

Queste variabili di sistema sono state utilizzate nell'iteratore Per ogni file
in una cartella di Ciclo. Tuttavia, in Automation 360, una variabile di tipo
dizionario viene utilizzata per acquisire l'estensione e il nome del file, che
possono essere recuperati rispettivamente con il nome chiave "estensione" e
"nome".
Loop package on page 1681.

$Email$
$Email From$
$Email Message$
$Email Received
Date$
$Email Received
Time$
$Email Subject$
$Email To$
$Email Sent date$
$Email Sent time$

Queste variabili di sistema sono state utilizzate all'interno dell'iteratore
Per ogni posta nella casella di posta di Ciclo. In Automation 360, una
variabile di tipo dizionario viene utilizzata per acquisire tutti i valori e-mail che
possono essere recuperati con le rispettive chiavi.
Consulta Using dictionary variable for email properties on page 1519.
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Variabile di sistema Come avviene la migrazione a Automation 360

$Filedata Column$ Questa variabile di sistema fa ora parte dell'iteratore Per ogni riga in CSV/
TXT in Loop. The system creates a new variable in the loop and uses it
inside the loop wherever $Filedata Column$ is present.
Se la variabile viene utilizzata all'esterno di un loop, viene convertita in una
variabile definita dall'utente di tipo record e assegnata a un'azione Record
che consente di assegnare il valore della variabile record di origine alla
variabile record di destinazione. Pertanto, quando si eseguono i bots migrati
che contengono questa variabile, vengono visualizzati i dati dell'ultima riga.

$FolderName$ Questa variabile di sistema viene utilizzata all'interno dell'iteratore Per
ogni cartella in una cartella di Ciclo. In Automation 360, il valore viene
restituito alla variabile di stringa specificata nel loop.

$Excel Cell Row$ Questa variabile di sistema viene migrata all'azione Ottieni numero di riga
del pacchetto Excel in Automation 360 e aggiunta appena sopra l'azione in
cui viene utilizzata.
In Enterprise 11, the last executed Excel session is used as a Session Name
value in the Excel Cell Row variable. However, in Automation 360, the
Excel Cell Row variable is not present. So, the last executed Excel session
used before Excel Cell Row is taken as a value for Get row number
during migration.
Soluzione: Create a string variable, assign a name to it, and add it after the
Excel command in the migrated bot. Use the newly created string variable in
Get row number.

$Excel Cell Collumn$ Questa variabile di sistema viene migrata all'azione Ottieni nome colonna
del pacchetto Excel in Automation 360 e aggiunta appena sopra l'azione in
cui viene utilizzata.
Enterprise 10/Enterprise 11 returns the first column (for example column
A) for the $Excel Cell Column$ even if the active cell is not column
A (for example column F10) inside a loop. In Automation 360, la stessa
configurazione restituisce la cella attiva (ad esempio la colonna F10). Di
seguito sono riportati i casi d'uso che determinano il cambiamento del
comportamento di cui sopra:
• Excel viene aperto con o senza contiene intestazione selezionata

contenente 10 righe.
• Imposta cella attiva come F10
• Viene eseguito un loop per la lettura della riga
• Put a Message Box with $Excel Cell Column$ in it
• Esegui il bot

Important:  Considerando le differenze di comportamento, potrebbe essere
necessario modificare alcuni bots.

$Excel Cell$ Questa variabile di sistema viene migrata all'azione Ottieni Indirizzo cella
del pacchetto Excel in Automation 360 e aggiunta appena sopra l'azione in
cui viene utilizzata.
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Variabile di sistema Come avviene la migrazione a Automation 360

$AATaskExecutor$ Questa variabile di sistema diventa $AATaskExecutor$ e
$AATaskInvoker$ in Automation 360.
In Enterprise 11, queste variabili restituiscono vari valori relativi
all'esecuzione e all'invocatore dell'attività (ad esempio, nome, cognome,
indirizzo e-mail e nome utente dell'invoker e dell'esecutore). In Automation
360, la variabile $AATaskInvoker$ restituisce i seguenti valori:
• Nome utente invoker
• Nome_invoker
• Cognome_invoker
• E-mail_invoker

La variabile $AATaskExecutor$ restituisce i seguenti valori:
• Executor_username (Nome utente esecutore)
• Nome_esecutore
• Executor_lastname (Cognome esecutore)
• E-mail_esecutore
• Tipo_esecutore

$AATaskName$ Questa variabile di sistema diventa $System.AATaskName$ in Automation
360.
In Enterprise 10/Enterprise 11, questa variabile restituisce il valore alla
directory del percorso del computer (ad esempio Automation Anywhere
\My Tasks\My Folder\My Folder2\AATaskName.atmx). In
Automation 360, restituisce il valore al percorso bot relativo a Control Room
(ad esempio Bots/AATaskName).

Action required:  Considerando che i valori restituiti sono diversi tra le
versioni, potresti dover modificare alcuni bots.
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Variabile di sistema Come avviene la migrazione a Automation 360

$AAApplicationPath$ Enterprise 11 specifica: Questa variabile di sistema Enterprise 11
restituisce il percorso impostato dagli utenti nell'impostazione Strumento
> Opzione di quella che è nota come “applicazione client”. In Automation
360, la variabile diventa un valore globale. Il processo di migrazione mappa
questa modifica automaticamente e il set di valori di ogni utente in Enterprise
11 viene copiato nella variabile di valore globale @AAApplicationPath.

Note:  Nessuna azione è richiesta da un utente per Enterprise 11 perché la
variabile di sistema viene mappata automaticamente come valore globale
durante la migrazione se hai utilizzato il database ripristinato Enterprise 11
durante l'installazione di Automation 360.

Enterprise 10 specifica: Questa variabile di sistema Enterprise 10 non
esegue automaticamente la migrazione a Automation 360 come valore
globale, pertanto, dopo la migrazione è necessaria un'azione.

Important:
• Gli utenti Enterprise 10 devono creare il valore globale

AAApplicationPath in Automation 360 e aggiornarlo con il percorso
Enterprise 10. Questo aggiornamento garantisce che quando esegui bot in
Automation 360, il valore della cartella AAApplicationPath sia risolto in
modo univoco per ogni utente.
Esempio: Se il valore del percorso Enterprise 10 per
AAApplicationPath è D:\John.Doe\My Documents\Automation
 Anywhere Files, è necessario creare il valore globale
AAApplicationPath in Automation 360 e aggiornarlo con questo
percorso.

• Assicurati che l'opzione È POSSIBILE effettuare la modifica sia
selezionata quando crei il valore globale AAApplicationPath. Bot
Creators e Bot Runners devono impostare il valore per il valore globale
AAAplicationPath prima di eseguire i bots migrati.

Consulta Valori globali on page 2044.

$AAInstallationPath$ Questa variabile di sistema diventa $System:AAInstallationPath$ in
Automation 360.
Enterprise 10/Enterprise 11 behavior: Returns the Enterprise Client
installation path (for example C:\Program Files (x86)\Automation
 Anywhere\Enterprise\Client).
Comportamento di Automation 360: Returns the Bot Agent installation
path (for example C:\Program Files\Automation Anywhere\Bot
 Agent).

Action required:  Considerando che i valori restituiti sono diversi tra le
versioni, potresti dover modificare alcuni bots.

$Current Directory$ Questa variabile di sistema è obsoleta in Automation 360 e convertita
automaticamente in una variabile definita dall'utente durante la migrazione.
The value of the variable is set per the value defined in Loop > For each
file in a folderr and For each folder in a folder.
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Variabile di sistema Come avviene la migrazione a Automation 360

$Date$ Questa variabile di sistema diventa $System:Date$ in Automation 360.
Enterprise 10 and Enterprise 11 behavior: La variabile $Date
$ restituisce la data e l'ora correnti nel formato specificato nel file
AA.Settings.XML.
Automation 360 behavior: La variabile $System:Date$ restituisce valori
di tipo Data e ora e gli utenti devono utilizzare un'azione per modificarli
in Stringa. Per ridurre al minimo le interruzioni per gli utenti, il processo di
migrazione esegue le seguenti operazioni per ogni istanza $Date$:
• Crea una variabile temporanea $SystemDateInString$ di tipo Stringa.
• Aggiunge un'azione In stringa del pacchetto Data e ora per convertire

$System:Date$ in stringa con il formato cliente "MM/gg/aaaa
HH:mm:ss" e memorizzare l'output nella variabile di stringa sopra.

• Utilizza questa variabile di stringa ogni volta che si utilizza $Date$.
• I passaggi precedenti vengono ripetuti per ogni occorrenza di $Date$.

A seconda della configurazione di bot, potrebbe essere necessario aggiornare
la configurazione data/ora.

Action required:  Modificare bot se il formato della data non è MM/gg/
aaaa HH:mm:ss.

$Error Line Number$
$Error Description$

In Enterprise 10 o Enterprise 11, queste variabili di sistema vengono
utilizzate dopo il comando Gestione errori. In Automation 360, il valore
viene restituito alle variabili definite dall'utente specificate nell'azione
Cattura .

$PDFFileName$
$PDFTitle$
$PDFAuthor$
$PDFSubject$

In Enterprise 10 o Enterprise 11, queste variabili di sistema sono state
utilizzate dopo qualsiasi comando PDF. In Automation 360, una variabile di
tipo Dizionario viene utilizzata per acquisire tutti i valori PDF che possono
essere recuperati con le rispettive chiavi. Ogni azione PDF restituisce questa
variabile Dizionario con i valori PDF corrispondenti.
Consulta Using a dictionary variable for PDF properties on page 1740.

$System$ In Enterprise 11 o Enterprise 10, questa variabile di sistema viene utilizzata
per recuperare informazioni sulle impostazioni e sulle prestazioni di un
dispositivo. In Automation 360, si utilizza l'action Ottieni variabile
ambiente di System package.
Consulta Get environment variable action on page 1892.
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Variabile di sistema Come avviene la migrazione a Automation 360

$WorkItem$ • $WorkItem$ è una Stringa: Migrato così com'è.
• $WorkItem$ è un Numero

• Se viene visualizzato o registrato un Numero, il numero viene
modificato in una stringa

• Se viene visualizzato come Numero, migrare come tipo di Numero

• $WorkItem$ è Data e Ora: Migrato così com'è, ma il pacchetto migrato
genera un errore, quindi non puoi eseguire la migrazione del pacchetto.

Note:  Per il tipo Data e Ora, non è ancora possibile eseguire la migrazione
del pacchetto, quindi è necessario eseguire la migrazione del bot associato in
un altro momento.

$Trigger Value$ Diventa $TriggerValue$ in Automation 360. Per i bots Enterprise 11 che
utilizzano questa variabile, eseguire le seguenti operazioni per eseguire
correttamente la migrazione dei bots:
• Crea i trigger equivalenti in Automation 360 per tutti i trigger utilizzati nei

bots Enterprise 11.
L'output dei trigger in Automation 360 è memorizzato in una variabile di
tipo record.

• Aggiorna i bots migrati per utilizzare le azioni appropriate per assegnare i
valori dalla variabile record che contiene l'output dei trigger alla variabile
$TriggerValue$.
Ad esempio, se desideri assegnare un host e una chiave della
porta dalla variabile record di un trigger di posta elettronica alla
variabile $TriggerValue$, usa l'espressione $EmailTriggerData(host)$
$EmailTriggerData(port)$. Analogamente, per recuperare la
posizione di un file, usa l'espressione $FileTriggerData(file)$,
e per recuperare la posizione di una cartella usa le espressioni
$FolderTriggerData(fromFolder)$.

$Table Column$ Questa variabile di sistema fa ora parte dell'iteratore Per ogni riga in una
tabella in Loop. The system creates a new variable in the loop and uses it
inside the loop wherever $Table Column$ is present.
Se la variabile viene utilizzata all'esterno di un loop, viene convertita in una
variabile definita dall'utente di tipo record e assegnata a un'azione Record
che consente di assegnare il valore della variabile record di origine alla
variabile record di destinazione. Pertanto, quando si eseguono i bots migrati
che contengono questa variabile, vengono visualizzati i dati dell'ultima riga.

$XML Data Node$ Questa variabile di sistema viene utilizzata all'interno dell'iteratore Per
ogni nodo in set di dati XML di Ciclo. In Automation 360, il valore viene
restituito alla variabile di stringa specificata nel loop.
Se la variabile viene utilizzata all'esterno di un loop, viene convertita in una
variabile definita dall'utente di tipo stringa e assegnata a un'azione Record
che consente di assegnare il valore della variabile record di origine alla
variabile record di destinazione. Pertanto, quando si eseguono i bots migrati
che contengono questa variabile, vengono visualizzati i dati dell'ultima riga.
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Variabili di credenziale

Le variabili delle credenziali utilizzate per i campi Nome utente e Password in Enterprise 10 e Enterprise
11 vengono migrate come Variabili di credenziali in Automation 360.
Il metodo di migrazione differisce per Enterprise 10 e Enterprise 11.
Per informazioni su come migrare le credenziali Enterprise 10, consulta la sezione sulle credenziali in Come
vengono copiati i dati di Enterprise 10 in Automation 360 on page 1204.
Le variabili delle credenziali utilizzate in campi diversi dai campi Nome utente e Password vengono
migrate come Valori globali. Questi campi includono nome host, numero di porta e così via. I
valori globali migrati hanno la seguente sintassi: <credentialname>_<attributename>. For
example in Enterprise 11, a credential FTPConnection with an attribute hostname is migrated as
FTPConnection_hostname.
La tabella seguente fornisce informazioni su packages e actions che supportano la migrazione delle variabili
delle credenziali da Enterprise 11 a Automation 360:

Package Actions

Active Directory • Crea e modifica utente
• Crea e modifica gruppo
• Crea e modifica oggetto
• Ricerca
• Ottieni proprietà

Database • Connetti con stringa di connessione
• Nome utente
• Password

Email Automation • Nome host
• Nome utente
• Password

Excel Apri foglio di calcolo

FTP / SFTP Connetti

Insert Keystrokes Tutte le sequenze di tasti che richiedono l'uso di
credenziali

Legacy Automation Imposta testo nell'azione Gestisci controlli Web

Manage Window Controls • Imposta testo
• Aggiungi testo

PDF • Da PDF a immagine
• Estrai campi modulo
• Estrai testo
• Divisione, crittografia e decrittografia del

documento
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Package Actions

PGP • Crittografia e decrittografia dei file
• Crea chiavi

Recorder • Imposta testo
• Aggiungi testo

Note:  Migrazione dal comando Object Cloning
come azione di acquisizione.

REST Web Service • URI
• Nome utente
• Password
• Intestazioni
• Parametri operazione

Note:  Il nome di dominio viene migrato come
valore globale.

SOAP Web Service • Nome utente
• Password
• Intestazioni
• Parametri operazione
• Parametri dati non elaborati

Terminal Emulator • Comando di connessione per SSH2 con opzioni
di autenticazione dei file utente e chiave

• Invia testo
• Imposta campo

Web Recorder Gestione dei controlli Web con le funzioni Imposta
testo e Aggiungi testo

Valori globali in bots migrati
Dopo la migrazione, i bots utilizzano vari valori globali per supportare diverse capacità fornite in Enterprise
11 o Enterprise 10. È necessario creare o aggiornare questi valori globali in Automation 360 per assicurarsi
che la migrazione dei bots venga eseguita correttamente.

Note:  Global values are created when you migrate bots for the first time using the Bot Migration Wizard
or migration APIs. If you are using the Migration package to migrate bots, you must create the global
values manually.

La seguente tabella elenca i vari valori globali che sono usati dai bots migrati per la corretta esecuzione:
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Valore globale Descrizione

AAApplicationPath Usa questo valore globale per specificare il
percorso fisico di un bot o di un file che viene
utilizzato nel bot attuale.
• Enterprise 11: Questa variabile globale

viene creata automaticamente dal sistema se
hai usato il database Enterprise 11 ripristinato
durante l'installazione di Automation 360.

• Enterprise 10: Devi creare questo valore
globale in Automation 360 e aggiornare
tutti i bots Enterprise 10 che hanno usato
la variabile di sistema AAApplicationPath
al valore globale AAApplicationPath in
Automation 360 con lo stesso valore di
Enterprise 10.

Come viene migrata la variabile AAApplicationPath
on page 1235

AABasePath Questo valore globale è equivalente all'opzione
Percorso dell'attività "Inizia in" in Enterprise
11 o Enterprise 10.
In Enterprise 11 o Enterprise 10, questa opzione
viene usata per specificare la posizione di nuovi
file o cartelle quando un percorso relativo per il
file o la cartella in questione è specificato in un
comando. Quando si migrano bots Enterprise 11
o Enterprise 10, tieni presente quanto segue:
• Se il percorso nel bot Enterprise 11 o

Enterprise 10 è un percorso assoluto, il
processo di migrazione non apporta alcun
cambiamento nel bot migrato.

• Se il percorso nel bot Enterprise 11 o
Enterprise 10 è un percorso relativo e non
contiene alcuna variabile, il processo di
migrazione aggiunge un prefisso al percorso
con il valore globale AABasePath.

• Se il percorso nel bot Enterprise 11 o
Enterprise 10 è un percorso relativo e
contiene variabili:
• Se la variabile contiene un percorso

assoluto, il processo del tempo di
esecuzione non apporta alcuna modifica al
bot migrato.

• Se la variabile contiene un percorso
relativo, il processo del tempo di
esecuzione aggiunge un prefisso al
percorso con il valore globale AABasePath.

AADefaultDateFormat Use this global value to change the default date
and time format for Date variables.
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Valore globale Descrizione

AAE_EmailSettings_auth Use this global value to enable or disable
authentication for the email server.

AAE_EmailSettings_clientId Use this global value to specify the client ID that
is generated when you registered the application
in the Microsoft Azure portal.

AAE_EmailSettings_domainName Use this global value to specify a domain name
for the email server.

AAE_EmailSettings_host Usa questo valore globale per specificare il
nome host del server e-mail da usare per inviare
notifiche via e-mail sullo stato di un bot.

AAE_EmailSettings_port Usa questo valore globale per specificare la porta
che desideri utilizzare per connetterti al server e-
mail.

AAE_EmailSettings_ssl Usa questo valore globale per specificare se
l'account e-mail utilizza la connessione sicura.

AAE_EmailSettings_tenantId Usa questo valore globale per specificare l'ID
tenant che viene generato dopo aver registrato
l'applicazione nel portale Microsoft Azure.

AAProxyHost Use this global value to specify the proxy host
that will primarily be used by the REST Web
Service and SOAP Web Service actions.

AAProxyPort Use this global value to specify the proxy port
that will primarily be used by the REST Web
Service action.

AARestTimeOut Use this global value to specify the timeout
value, in milliseconds, for the REST Web Service
action. This value can be used when the REST
server takes a long time to respond.

AASoapTimeOut Use this global value to specify the timeout
value, in milliseconds, for the SOAP Web Service
action. This value can be used when the SOAP
server takes a long time to respond.

AAWaitForControl Use this global value to specify the maximum
wait time, in seconds, for the Control Room.

JcoDllPath Use this global value to specify the DLL path
for the Java connector used in SAP Business
Application Programming Interface (BAPI).

JcoJarPath Use this global value to specify the JAR path for
the Java connector used in SAP BAPI.
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Verificare la migrazione bot
È importante verificare che la migrazione sia completata e che bot migrato si esegua correttamente
nell'ambiente Automation 360. bot potrebbe essere stato convertito, ma potrebbe contenere errori che ne
impediscono l'esecuzione.
1. Accedi al tuo Automation 360 ambiente da un computer con Bot Agent installato utilizzando un Bot

Creator account e l'autorizzazione "Visualizza migrazione".
2. Verifica che la migrazione sia stata completata correttamente facendo clic su Amministrazione >

Migrazione.
3. Confirm that your migration instance has the successful status (green check mark) and the

Migrated Item column shows 1 to indicate that 1 bot was migrated.
If the Migrated Item column shows 0, your bot has not migrated successfully and will not be
available on the Automation page.

4. Verifica che il bot venga eseguito correttamente facendo clic su Attività > In corso.
5. Passa a bot migrato.

Ad esempio, se hai migrato un bot dalla cartella Le mie attività, passa alla stessa cartella per
trovare il tuo bot migrato.

6. Fai clic su bot e correggi eventuali errori.
7. Esegui bot per confermare che tutti gli errori sono stati corretti.

Related concepts
Migrazione a Automation 360 on page 1126
Related tasks
Visualizzazione delle modifiche ai bots migrati utilizzando Bot Assistant on page 1301
Bot Assistant fornisce una visione completa di tutte le righe di un bot che richiedono una revisione o
un'azione da parte dell'utente, oppure che contengono errori che devono essere risolti. Puoi identificare
rapidamente le aree dei bots che richiedono attenzione e visualizzare i cambiamenti in un bot Enterprise 11
o Enterprise 10 dopo la migrazione di Automation 360.

Visualizza i rapporti di migrazione
Utilizza i report per analizzare lo stato della migrazione bot individuale, della migrazione dei dati e della
migrazione dei log di audit e per identificare lo stato e il riepilogo della singola migrazione.
Devi disporre dell'autorizzazione Visualizza migrazione per accedere a questi report.
I report di migrazione forniscono un riepilogo e lo stato in base al seguente tipo di migrazione:
• La migrazione bot che include dettagli sulla conversione di Enterprise 10 o Enterprise 11 bot in

Automation 360.
• La migrazione dei dati che include dettagli sulla copia dei dati Enterprise 10 in Automation 360.
• La migrazione dell'audit include dettagli sui dati Enterprise 11 di log di audit migrati in Automation 360.

Access the reports from the Administration > Migrations > View migration icon associated with the
migration instance for which you want to view the report.
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• Report di migrazione Bot: Si applica sia a Enterprise 10 che a Enterprise 11.
Visualizza le seguenti informazioni:
• I dettagli di migrazione, ad esempio il nome dell'istanza di migrazione, la relativa descrizione e lo

stato.
• I risultati della migrazione, ad esempio l'ora di inizio e di fine del processo di migrazione, lo stato

della migrazione e il numero di elementi migrati.
• Impostazioni: Se l'opzione per sovrascrivere i file è stata selezionata.
• Bot Runners: Informazioni su Esegui come utente selezionato per l'istanza di migrazione.
• Risultati di migrazione Bot, ad esempio tutti i bots (genitore bots e relativo figlio bots) migrati e il

relativo stato.
The bot migration result separately lists the bots that might require action or review after migration.
Navigate to the each tab to view the list of bots that will require action or review and plan the post
migration steps accordingly.
Fai clic sull'icona Visualizza problemi di migrazione associata a un bot migrato senza successo per
visualizzare i comandi o gli attributi non supportati.

• Dettagli generali sull'utente che ha creato l'istanza di migrazione, la data dell'ultima modifica e il
relativo tipo di oggetto.

• Risultati migrazione Bot Insight: Si applica solo a Enterprise 11.
Visualizza Bot Insight i risultati se hai migrato Enterprise 11 l'analisi bots. Questa scheda visualizza
informazioni quali lo stato della migrazione Bot Insight, il numero di dashboard Bot Insight e le righe
di dati che vengono migrate, non migrate o saltate.

• Report sulla migrazione dei dati: Si applica solo a Enterprise 10.
Visualizza le seguenti informazioni:
• I dettagli di migrazione, ad esempio il nome dell'istanza di migrazione, la relativa descrizione e lo

stato.
• Risultati della migrazione dei dati, ad esempio l'ora di inizio e di fine del processo di migrazione, lo

stato della migrazione e il numero di elementi migrati.
• Ruoli che vengono copiati e il loro stato.
• Utenti copiati e il loro stato.
• Credenziali di accesso automatico copiate e relativo stato.
• Bots che vengono copiati e il loro stato.
• Le pianificazioni copiate e il relativo stato. Le pianificazioni copiate sono disabilitate in Automation

360 perché la migrazione dei dispositivi associati non è supportata e quindi non sono disponibili.
• Dettagli generali sull'utente che ha creato l'istanza di migrazione, la data dell'ultima modifica e il

relativo tipo di oggetto.

• Report di migrazione log di audit: Si applica solo a Enterprise 11.
Visualizza le seguenti informazioni:
• I dettagli di migrazione, ad esempio il nome dell'istanza di migrazione, la relativa descrizione e lo

stato generale della migrazione, ad esempio in corso, riuscita o non riuscita.
• I risultati della migrazione, ad esempio l'ora di inizio e di fine del processo di migrazione, la durata e

il numero di elementi saltati, non migrati o migrati.
• Risultati della migrazione del log di audit, ad esempio il percorso dei file JSON del log di audit,

lo stato di ogni file es_export.json se è stato saltato, non migrato, migrato o è in attesa di
migrazione. Visualizza inoltre i motivi per cui un particolare file es_export.json è stato saltato o
non è riuscito durante la migrazione dei log di audit.

• Dettagli generali sull'utente che ha creato l'istanza di migrazione, la data dell'ultima modifica e il
relativo tipo di oggetto.

© 2023 Automation Anywhere. All rights reserved.     1300



    Automation Anywhere - Migrazione a Automation 360

View the following video on how to review the bot migration report:

Esporta in CSV
Puoi esportare due set di dati in un file CSV: le istanze di migrazione nella pagina Tutte le migrazioni
e bot i dati dei risultati della migrazione, inclusa qualsiasi mappatura delle azioni per ciascun bot. I dati
esportati possono essere utilizzati per l'analisi offline e per identificare i bots di cui non è stata eseguita
correttamente la migrazione e le azioni associate.
Per i dati dell'istanza di migrazione, il processo di esportazione esporta tutti i dati (incluse le colonne di dati
nascoste), ma solo per la pagina corrente. Se si dispone di istanze di migrazione su pagine aggiuntive, è
necessario spostarsi su tali pagine per esportare tali dati. Per i dati dei risultati della migrazione, tutte le
pagine vengono esportate, anche se i dati sono impaginati.
Gli utenti con l'autorizzazione "Visualizza migrazione" possono eseguire l'esportazione.
1. Click Administration > Migrations.
2. Esportare istanze di migrazione:

a) Utilizza le caselle di controllo per selezionare le istanze di migrazione da esportare.
b) Fai clic sull'icona Esporta elementi selezionati in CSV.

3. Esportare i dati dei risultati della migrazione:
a) Seleziona l'istanza di migrazione in cui Tipo è la migrazione Bot che desideri esportare.

È possibile esportare solo i risultati della migrazione bot.
b) Fai clic sull'opzione Esporta risultati migrazione bot per esportare i dati.

È inoltre possibile esportare dal report di Migrazione.

4. Apri il file CSV per visualizzare i dati esportati.

Visualizzazione delle modifiche ai bots migrati utilizzando Bot
Assistant
Bot Assistant fornisce una visione completa di tutte le righe di un bot che richiedono una revisione o
un'azione da parte dell'utente, oppure che contengono errori che devono essere risolti. Puoi identificare
rapidamente le aree dei bots che richiedono attenzione e visualizzare i cambiamenti in un bot Enterprise 11
o Enterprise 10 dopo la migrazione di Automation 360.
• Enterprise 11 o Enterprise 10 bots devono essere migrati a Automation 360.
• All'utente che rivede i messaggi relativi alle revisioni e alle azioni di migrazione deve essere assegnata la

licenza Bot Creator o Bot Runner.
• I Bot Creators devono disporre dell'autorizzazione Visualizza migrazione per visualizzare i messaggi

relativi alle revisioni e alle azioni di migrazione nel Bot Assistant.

I messaggi di revisione sono disponibili per i bots che sono stati migrati correttamente in Automation
360 ma con alcune modifiche ai bots migrati. Questi messaggi di revisione indicano le modifiche nel
comportamento dei comandi Enterprise 11 o Enterprise 10 dopo che sono stati migrati a Automation 360.
Puoi aprire il Bot Assistant per un bot migrato che è elencato nella scheda Messaggi del report del Bot
Scanner. Dopo la migrazione, esamina le modifiche apportate ai comandi e contrassegna tali messaggi
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come rivisti dopo l'analisi della modifica. Il Bot Assistant consente anche di rivedere tutte le modifiche
apportate in un bot dal Bot editor.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Apri il bot migrato per il quale desideri rivedere i messaggi.
3. Fai clic sull'icona di Bot Assistant sulla barra degli strumenti per aprire Bot Assistant.
4. Fai clic su Inizia.
5. Nella schermata del Bot Assistant, fai clic sulla scheda Revisione necessaria per elencare i messaggi

che devono essere rivisti.
6. Fai clic su un messaggio nella scheda Revisione necessaria per visualizzare le informazioni

dettagliate sulla modifica.
7. Fai clic sull'opzione Contrassegna come rivisto per contrassegnare il messaggio come rivisto.

I messaggi contrassegnati come rivisti sono disponibili nella scheda Rivisti.

Note:  Puoi contrassegnare un messaggio come rivisto solo per il bots migrato disponibile nell'archivio
privato.

See the following video on how to use the Bot Assistant to review changes to migrated bots

Messaggi di migrazione
Migration messages might display at any stage of the migration or Internet Explorer bot conversion. You
can review or act on migration messages from these possible sources: Bot Scanner report, Bot Assistant or
Bot migration report.

Note:
• Some messages described on this page do not include a cause or action when the cause is provided as

part of the message and do not require any further action.
• This page also includes Internet Explorer conversion messages that are applicable only for customers

impacted by the Internet Explorer end-of-life (EOL) and have chosen to convert IE bots.

Messaggi Azione richiesta

These messages in the Bot Scanner report, Bot Migration Wizard, and Migration Assistant after you migrate
the bots. You must perform certain actions to successfully run the bots. We recommend that you review
the cause and action required to update and run these bots.

Codice A101
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Messaggio Affinché il bot migrato venga eseguito, aggiorna la
variabile <nome> se la variabile viene utilizzata come
posizione di indice e non come nome di colonna.

Se la variabile viene utilizzata come nome di colonna,
non sono necessarie ulteriori azioni. Se viene utilizzata
come posizione di indice, crea una nuova variabile di tipo
numero. Tieni presente anche che la posizione iniziale
dell'indice Automation 360 è 0 invece di 1.

Causa If you used the FileData Column[$variable$] or Excel
 Column[$variable$] system variables in the Enterprise 11 or Enterprise
10 bot, it is assumed that you have used the column name in the $variable$. In
such cases, the migrated bot contains the FileData Column{$variable$}
expression.

Azione If the $variable$ in the Enterprise 11 or Enterprise 10 bot contains
the column number, update the expression in the migrated bot to
FileDataColumn[$var.String:toNumber()$].

Codice A103

Messaggio Per eseguire il bot migrato, aggiorna Task Bot: Esegui
l'azione nel bot migrato specificando la variabile delle
credenziali del parametro di input. Una variabile Credential
Vault non può essere trasferita in modo non sicuro.

Causa I campi del bot Enterprise 11 o Enterprise 10 migrato visualizzano il valore come
testo normale, in modo da evitare il rischio di una violazione della sicurezza in
Automation 360, alla variabile Credential Vault viene impedito di essere trasferita
in modo non sicuro (o rischioso).
Funzioni non supportate con soluzione alternativa

Codice A108

Messaggio Affinché il bot migrato venga eseguito, aggiornare l'azione
nel bot migrato specificando un valore appropriato per
Credential Vault.

Un valore Credential Vault di Automation 360 deve
corrispondere al valore Credential Vault della versione
10.x/11.x.

Causa The migrated bot does not have the Credential Vault value assigned to the
corresponding action.

Azione Per eseguire il bot migrato, creare o aggiorna il valore Credential Vault e
assegnalo all'azione corrispondente. Verifica che il valore Credential Vault
in Automation 360 sia uguale al valore Credential Vault di Enterprise 10 o
Enterprise 11.
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Codice A109

Messaggio Mancano le variabili di riferimento nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna le
azioni corrispondenti nel bot migrato fornendo le variabili
mancanti richieste.

Causa il bot Enterprise 11 o Enterprise 10 fa riferimento a una variabile inesistente nel
comando Funzionamento variabili.

Azione Crea una variabile con lo stesso nome e tipo oppure rimuovi il comando che fa
riferimento alla variabile inesistente.

Codice A110

Messaggio Mancano le variabili di riferimento nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione IF nel bot migrato fornendo le variabili mancanti
richieste.

Causa Il bot Enterprise 11 o Enterprise 10 fa riferimento a una variabile inesistente nel
comando If.

Azione Crea una variabile con lo stesso nome e tipo o rimuovi il comando che fa
riferimento alla variabile inesistente.

Codice A111

Messaggio Mancano le variabili di riferimento nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione Assegna ad Appunti nel bot migrato fornendo le
variabili mancanti richieste.

Causa Il bot Enterprise 11 o Enterprise 10 fa riferimento a una variabile inesistente nel
comando Assegna ad Appunti.

Azione Aggiorna l'azione Assegna ad Appunti con la variabile mancante richiesta nel
bot migrato in modo che le variabili di riferimento siano dello stesso tipo.

Codice A112

Messaggio Mancano le variabili di riferimento nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione ElseIF nel bot migrato fornendo le variabili
mancanti richieste.
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Causa Il bot Enterprise 11 o Enterprise 10 fa riferimento a una variabile inesistente nel
comando ElseIF.

Azione Crea una variabile con lo stesso nome e tipo oppure rimuovi il comando che fa
riferimento alla variabile inesistente.

Codice A113

Messaggio Mancano le variabili di riferimento nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione Loop nel bot migrato fornendo le variabili mancanti
richieste.

Causa Il bot Enterprise 11 o Enterprise 10 fa riferimento a una variabile inesistente nel
comando Loop.

Azione Crea una variabile con lo stesso nome e tipo o rimuovi il comando che fa
riferimento alla variabile inesistente.

Codice A116

Messaggio The MetaBot Logic referenced in the TaskBot is missing. For
the migrated bot to run, ensure the referenced MetaBot logic
bot is available at the required path in A360. Message code:
A116

Causa The Enterprise 11 or Enterprise 10 bot references a non-existent Taskbot.

Azione Ensure that the MetaBot Logic bot exists in Automation 360.

Codice A117

Messaggio The MetaBot Logic referenced in the parent MetaBot Logic is
missing. For the migrated bot to run, ensure the referenced
MetaBot Logic bot is available at the required path in A360.
Message code: A117

Causa The Enterprise 11 or Enterprise 10 parent MetaBot Logic references are missing.

Azione Ensure that the MetaBot Logic bot exists in Automation 360.

Codice A118

Messaggio Affinché il bot migrato venga eseguito, assicurati che nel
percorso richiesto sia disponibile il bot figlio.

Per l'esecuzione del bot padre è necessario un MetaBot
figlio.
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Causa When migrating a parent bot, if you have not migrated the child bot or you
migrated the child bot at a different location.

Azione Verifica che la migrazione del bot figlio sia stata eseguita correttamente. Dopo
aver verificato, esegui una delle seguenti azioni:
• Update the link within the parent bot so that it points to the correct location of

the migrated child bot.
• Sposta il bot figlio nella stessa posizione in cui si trova il bot padre.

Codice A119

Messaggio Manca un file DLL di riferimento nel bot V10/11.

For the migrated bot to run, ensure the referenced DLL file
is available at the required path.

Causa Quando esegui la migrazione di un bot padre, se il file DLL non è stato migrato o
se il file DLL è stato migrato in una posizione diversa, si verifica questo problema.

Azione Verifica che il file DLL di riferimento sia stato migrato correttamente. Dopo aver
verificato, esegui una delle seguenti azioni:
• Aggiorna il collegamento all'interno del bot migrato in modo che sia indirizzato

alla posizione corretta del file DLL migrato.
• Sposta il file DLL nella stessa posizione della posizione del bot migrato.

Codice A124

Messaggio L'azione "Riproduci suono" è stata migrata.I formati di
file .mid, .wma e .avi non sono supportati.

Aggiorna i file in formato .mp3 o .wav per eseguire il bot
migrato.

Codice A125

Messaggio Il valore delle credenziali di tipo non stringa non è
supportato per DLL Esegui funzione nel bot migrato.

Per eseguire il bot migrato, aggiorna "DLL - Esegui
funzione" con una variabile di credenziali di tipo stringa
o un valore globale di tipo di variabile appropriato e
mappatura corrispondente.

Per ulteriori informazioni, consulta la documentazione.

Causa Per l'azione DLL Esegui è supportato il valore delle credenziali solo di tipo di
stringa. If the credential value is deleted from the DLL Run command in the
Enterprise 10 or Enterprise 11 bot, then this issue occurs.
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Azione Aggiorna l'azione DLL Esegui nel bot migrato specificando il valore della
credenziale di tipo stringa e mappalo nei parametri corrispondenti nel bot migrato
per l'esecuzione. Se desideri trasferire un tipo di variabile diverso da stringa, crea
un valore globale della variabile richiesta e mappalo nell'azione DLL Esegui.

Codice A126

Messaggio Mancano le variabili di riferimento nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-BeforeAfter" nel bot migrato fornendo le
variabili mancanti richieste.

Causa In the Enterprise 10 or Enterprise 11 bot, if the referenced variable is deleted
from the String-BeforeAfter command, there are no issues. Tuttavia, dopo
la migrazione, la variabile mancante causa un problema perché la variabile di
riferimento è necessaria per eseguire il bot in Automation 360.

Azione Poiché la variabile di riferimento è necessaria per l'esecuzione del bot, crea la
variabile mancante e assegnala all'azione String-BeforeAfter.

Codice A127

Messaggio Mancano le variabili di riferimento nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-Compare" nel bot migrato fornendo le
variabili mancanti richieste.

Causa In the Enterprise 10 or Enterprise 11 bot, if the referenced variable is deleted
from the String-Compare command, there are no issues. Tuttavia, dopo la
migrazione, la variabile mancante causa un problema perché la variabile di
riferimento è necessaria per eseguire il bot in Automation 360.

Azione Poiché la variabile di riferimento è necessaria per l'esecuzione del bot, crea la
variabile mancante e assegnala all'azione String-Compare.

Codice A128

Messaggio Mancano le variabili di riferimento nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-Find" nel bot migrato fornendo le variabili
mancanti richieste.

Causa In the Enterprise 10 or Enterprise 11 bot, if the referenced variable is deleted
from the String-Find command, there are no issues. Tuttavia, dopo la
migrazione, la variabile mancante causa un problema perché la variabile di
riferimento è necessaria per eseguire il bot in Automation 360.
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Azione Poiché la variabile di riferimento è necessaria per l'esecuzione del bot, crea la
variabile mancante e assegnala all'azione String-Find.

Codice A129

Messaggio Mancano le variabili di riferimento nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-Join" nel bot migrato fornendo le variabili
mancanti richieste.

Causa In the Enterprise 10 or Enterprise 11 bot, if the referenced variable is deleted
from the String-Join command, there are no issues. Tuttavia, dopo la
migrazione, la variabile mancante causa un problema perché la variabile di
riferimento è necessaria per eseguire il bot in Automation 360.

Azione Poiché la variabile di riferimento è necessaria per l'esecuzione del bot, crea la
variabile mancante e assegnala all'azione String-Join.

Codice A130

Messaggio Mancano le variabili di riferimento nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-Length" nel bot migrato fornendo le
variabili mancanti richieste.

Causa In the Enterprise 10 or Enterprise 11 bot, if the referenced variable is deleted
from the String-Length command, there are no issues. Tuttavia, dopo la
migrazione, la variabile mancante causa un problema perché la variabile di
riferimento è necessaria per eseguire il bot in Automation 360.

Azione Poiché la variabile di riferimento è necessaria per l'esecuzione del bot, crea la
variabile mancante e assegnala all'azione String-Length.

Codice A131

Messaggio Mancano le variabili di riferimento nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-Lowercase" nel bot migrato fornendo le
variabili mancanti richieste.

Causa In the Enterprise 10 or Enterprise 11 bot, if the referenced variable is deleted
from the String-Lowercase command, there are no issues. Tuttavia, dopo
la migrazione, la variabile mancante causa un problema perché la variabile di
riferimento è necessaria per eseguire il bot in Automation 360.

Azione Poiché la variabile di riferimento è necessaria per l'esecuzione del bot, crea la
variabile mancante e assegnala all'azione String-Lowercase.
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Codice A132

Messaggio Mancano le variabili di riferimento nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-Replace" nel bot migrato fornendo le
variabili mancanti richieste.

Causa In the Enterprise 10 or Enterprise 11 bot, if the referenced variable is deleted
from the String-Replace command, there are no issues. Tuttavia, dopo la
migrazione, la variabile mancante causa un problema perché la variabile di
riferimento è necessaria per eseguire il bot in Automation 360.

Azione Poiché la variabile di riferimento è necessaria per l'esecuzione del bot, crea la
variabile mancante e assegnala all'azione String-Replace.

Codice A133

Messaggio Mancano le variabili di riferimento nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-Reverse" nel bot migrato fornendo le
variabili mancanti richieste.

Causa In the Enterprise 10 or Enterprise 11 bot, if the referenced variable is deleted
from the String-Reverse command,, there are no issues. Tuttavia, dopo la
migrazione, la variabile mancante causa un problema perché la variabile di
riferimento è necessaria per eseguire il bot in Automation 360.

Azione Poiché la variabile di riferimento è necessaria per l'esecuzione del bot, crea la
variabile mancante e assegnala all'azione String-Reverse.

Codice A134

Messaggio Mancano le variabili di riferimento nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-Substring" nel bot migrato fornendo le
variabili mancanti richieste.

Causa In the Enterprise 10 or Enterprise 11 bot, if the referenced variable is deleted
from the String-Substring command, there are no issues. Tuttavia, con la
migrazione, la variabile mancante causa un problema perché la variabile di
riferimento è necessaria per eseguire il bot in Automation 360.

Azione Poiché la variabile di riferimento è necessaria per l'esecuzione del bot, crea la
variabile mancante e assegnala all'azione String-Substring.

Codice A135
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Messaggio Mancano le variabili di riferimento nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-Trim" nel bot migrato fornendo le variabili
mancanti richieste.

Causa In the Enterprise 10 or Enterprise 11 bot, if the referenced variable is deleted
from the String-Trim command, there are no issues. Tuttavia, dopo la
migrazione, la variabile mancante causa un problema perché la variabile di
riferimento è necessaria per eseguire il bot in Automation 360.

Azione Poiché la variabile di riferimento è necessaria per l'esecuzione del bot, crea la
variabile mancante e assegnala all'azione String-Trim.

Codice A136

Messaggio Mancano le variabili di riferimento nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-Uppercase'" nel bot migrato fornendo le
variabili mancanti richieste.

Causa In the Enterprise 10 or Enterprise 11 bot, if the referenced variable is deleted
from the String-Uppercase command, there are no issues. Tuttavia, dopo
la migrazione, la variabile mancante causa un problema perché la variabile di
riferimento è necessaria per eseguire il bot in Automation 360.

Azione Poiché la variabile di riferimento è necessaria per l'esecuzione del bot, crea la
variabile mancante e assegnala all'azione String-Uppercase.

Codice A137

Messaggio Manca una variabile nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-BeforeAfter" nel bot migrato fornendo una
variabile valida.

Causa The unsupported variable type is assigned to the String-BeforeAfter action in
the migrated Enterprise 10 or Enterprise 11 bot.

Azione Per eseguire il bot migrato, crea un tipo di variabile stringa valida e assegnala
all'azione String-BeforeAfter.

Codice A138

Messaggio Manca una variabile nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-Compare" nel bot migrato fornendo luna
variabile valida.
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Causa The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 bot.

Azione Per eseguire il bot migrato, crea un tipo di variabile stringa e assegnala all'azione.

Codice A139

Messaggio Manca una variabile nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-Find" nel bot migrato fornendo una
variabile valida.

Causa The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 bot.

Azione Per eseguire il bot migrato, crea un tipo di variabile stringa e assegnala all'azione.

Codice A140

Messaggio Manca una variabile nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-Join" nel bot migrato fornendo una
variabile valida.

Causa The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 bot.

Azione Per eseguire il bot migrato, crea un tipo di variabile stringa e assegnala all'azione.

Codice A141

Messaggio Manca una variabile nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-Length" nel bot migrato fornendo una
variabile valida.

Causa The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 bot.

Azione Per eseguire il bot migrato, crea un tipo di variabile stringa e assegnala all'azione.

Codice A142
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Messaggio Manca una variabile nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-LowerCase" nel bot migrato fornendo una
variabile valida.

Causa The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 bot.

Azione Per eseguire il bot migrato, crea un tipo di variabile stringa e assegnala all'azione.

Codice A143

Messaggio Manca una variabile nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-Replace" nel bot migrato fornendo una
variabile valida.

Causa The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 bot.

Azione Per eseguire il bot migrato, crea un tipo di variabile stringa e assegnala all'azione.

Codice A144

Messaggio Manca una variabile nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-Reverse" nel bot migrato fornendo una
variabile valida.

Causa The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 bot.

Azione Per eseguire il bot migrato, crea un tipo di variabile stringa e assegnala all'azione.

Codice A145

Messaggio Manca una variabile nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-SubString" nel bot migrato fornendo una
variabile valida.

Causa The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 bot.

Azione Per eseguire il bot migrato, crea un tipo di variabile stringa e assegnala all'azione.
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Codice A146

Messaggio Manca una variabile nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-Trim" nel bot migrato fornendo una
variabile valida.

Causa The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 bot.

Azione Per eseguire il bot migrato, crea un tipo di variabile stringa valida e assegnala
all'azione.

Codice A147

Messaggio Manca una variabile nel bot V10/11.

Affinché il bot migrato possa essere eseguito, aggiorna
l'azione "String-UpperCase'" nel bot migrato fornendo una
variabile valida.

Causa The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 bot.

Azione Per eseguire il bot migrato, crea un tipo di variabile stringa valida e assegnala
all'azione.

Codice A149

Messaggio MetaBot screen that is referenced in the Logic is not
present in the MetaBot. For the migrated bot to run, update
the object details in the Recorder action. Message code:
A149

Causa Screen details are missing in the Recorder package of the migrated bot. Questi
dettagli della schermata sono obbligatori in Automation 360.

Azione È necessario acquisire manualmente i dettagli della schermata nel bot migrato per
consentire la corretta esecuzione.
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Codice A151

Note:  As of v.27, bots that contain non-referenced variables are not flagged
as Action Required or Review Required in the Bot Scanner utility for the
following variables:
• $Excel Column$
• $Filedata Column$
• $Dataset Column$
• $Table Column$
• $XML Data Node$
• $PDFTitle$
• $PDFSubject$
• $PDFFileName$
• $PDFAuthor$

Note:  As of v.25, bots that contain non-referenced variables are not flagged as
Action Required in the Bot Scanner utility for the following variables:
• '$Error Description$'
• '$Error Line Number$'
• '$FileName$'
• '$Extension$'
• $FolderName$'
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Messaggi 1. Il nome variabile '$Error Description$' è stato migrato
come '$Error-Description$'.

La variabile '$Error Description$' utilizzata nella
versione 10.x/11.x non viene creata in A360 a causa
dell'assenza di azioni dai pacchetti corrispondenti.

Affinché il bot migrato possa essere eseguito, crea una
variabile con lo stesso nome '$Error-Description$' o
rimuovi la variabile dalla rispettiva azione.

2. Il nome variabile '$Error Line Number$' è stato migrato
come '$Error-LineNumber$'.

La variabile '$Error Line Number$' utilizzata nella
versione 10.x/11.x non viene creata in A360 a causa
dell'assenza di azioni dai pacchetti corrispondenti.

Affinché il bot migrato possa essere eseguito, crea
una variabile con lo stesso nome '$Error-LineNumber$' o
rimuovi la variabile dalla rispettiva azione.

3. Il nome variabile '$FileName$' è stato migrato come
'$Loop-Files$'.
La variabile '$FileName$' utilizzata nella versione
10.x/11.x non viene creata in A360 a causa dell'assenza
di azioni dai pacchetti corrispondenti.

Affinché il bot migrato possa essere eseguito, crea una
variabile con lo stesso nome '$Loop-Files$' o rimuovi la
variabile dalla rispettiva azione.

4. Il nome variabile '$Estensione$' è stato migrato come
'$Files$'.
La variabile '$Extension$' utilizzata nella versione
10.x/11.x non viene creata in A360 a causa dell'assenza
di azioni dai pacchetti corrispondenti.

Affinché il bot migrato possa essere eseguito, crea una
variabile con lo stesso nome '$Loop-Files$' o rimuovi la
variabile dalla rispettiva azione.

5. Il nome variabile $FolderName$ è stato migrato come
'$Loop-FolderName$'.
La variabile '$FolderName$' utilizzata nella versione
10.x/11.x non viene creata in A360 a causa dell'assenza
di azioni dai pacchetti corrispondenti.

For the migrated bot to run, create a variable with the
same name '$Loop-FolderName$' or remove the variable from
the respective action.

6. Il nome variabile $PDFAuthor$' è stato migrato come
'$PDF-Metadata-Dictionary$'.

La variabile '$PDFAuthor$' utilizzata nella versione
10.x/11.x non viene creata in A360 a causa dell'assenza
di azioni dai pacchetti corrispondenti.

Affinché il bot migrato possa essere eseguito, crea una
variabile con lo stesso nome '$PDF-Metadata-Dictionary$'
o rimuovi la variabile dalla rispettiva azione.

7. Il nome variabile '$PDFFileName$' è stato migrato come
'$PDF-Metadata-Dictionary$'.
The '$PDFFileName$' variable used in version 10.x/ 11.x
is not created in the A360 due to the absence of actions
from corresponding packages.

Affinché il bot migrato possa essere eseguito, crea una
variabile con lo stesso nome '$PDF-Metadata-Dictionary$'
o rimuovi la variabile dalla rispettiva azione.

8. Il nome variabile '$PDFSubject$' è stato migrato come '$PDF-Metadata-
Dictionary$'.
La variabile '$PDFSubject$' utilizzata nella versione
10.x/11.x non viene creata in A360 a causa dell'assenza
di azioni dai pacchetti corrispondenti.

Affinché il bot migrato possa essere eseguito, crea una
variabile con lo stesso nome '$PDF-Metadata-Dictionary$'
o rimuovi la variabile dalla rispettiva azione.

9. Il nome variabile '$PDFTitle$' è stato migrato come
'$PDF-Metadata-Dictionary$'.

La variabile '$PDFTitle$' utilizzata nella versione
10.x/11.x non viene creata in A360 a causa dell'assenza
di azioni dai pacchetti corrispondenti.

Affinché il bot migrato possa essere eseguito, crea una
variabile con lo stesso nome '$PDF-Metadata-Dictionary$'
o rimuovi la variabile dalla rispettiva azione.

10. Il nome variabile '$XML Data Node$' è stato migrato come
'$Loop-XML-Data-Node$'.

La variabile '$XML Data Node$' utilizzata nella versione
10.x/11.x non viene creata in A360 a causa dell'assenza
di azioni dai pacchetti corrispondenti.

Affinché il bot migrato possa essere eseguito, crea una
variabile con lo stesso nome '$Loop-XML-Data-Node$' o
rimuovi la variabile dalla rispettiva azione.

11. Il nome variabile '$Excel Column$' è stato migrato come
'$Loop-Excel-Column$'.

La variabile '$Excel Column$' utilizzata nella versione
10.x/11.x non viene creata in A360 a causa dell'assenza
di azioni dai pacchetti corrispondenti.

Affinché il bot migrato possa essere eseguito, crea una
variabile con lo stesso nome '$Loop-Excel-Column$' o
rimuovi la variabile dalla rispettiva azione.

12. Il nome variabile '$Table Column$' è stato migrato come
'$Loop-Table-Column$'.

La variabile '$Table Column$' utilizzata nella versione
10.x/11.x non viene creata in A360 a causa dell'assenza
di azioni dai pacchetti corrispondenti.

Affinché il bot migrato possa essere eseguito, crea una
variabile con lo stesso nome '$Loop-Table-Column$' o
rimuovi la variabile dalla rispettiva azione.

13. Il nome variabile '$WorkItemResult$' è stato migrato come
'$workItemResult$'.

La variabile '$WorkItemResult$' utilizzata nella versione
10.x/11.x non viene creata in A360 a causa dell'assenza
di azioni dai pacchetti corrispondenti.

Affinché il bot migrato possa essere eseguito, crea una
variabile con lo stesso nome '$workItemResult$' o rimuovi
la variabile dalla rispettiva azione.

14. Il nome variabile '$Dataset Column$' è stato migrato come
'$Loop-Dataset-Column$'.

La variabile '$Dataset Column$' utilizzata nella versione
10.x/11.x non viene creata in A360 a causa dell'assenza
di azioni dai pacchetti corrispondenti.

Affinché il bot migrato possa essere eseguito, crea una
variabile con lo stesso nome '$Loop-Dataset-Column$' o
rimuovi la variabile dalla rispettiva azione.

15. Il nome variabile '$Filedata Column$' è stato migrato
come '$Loop-Filedata-Column$'.

La variabile '$Filedata Column$' utilizzata nella
versione 10.x/11.x non viene creata in A360 a causa
dell'assenza di azioni dai pacchetti corrispondenti.

Affinché il bot migrato possa essere eseguito, crea una
variabile con lo stesso nome '$Loop-Filedata-Column$' o
rimuovi la variabile dalla rispettiva azione.
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Causa (Applies to all A151 messages): questo problema si verifica se una determinata
variabile non viene creata in Automation 360 perché le azioni non sono presenti
nel pacchetto corrispondente.

Azione (Applies to all A151 messages): devi creare una variabile del tipo di variabile
pertinente (stringa, numero, dizionario e così via) con lo stesso nome in
Automation 360 o rimuovere la variabile dalla rispettiva azione per eseguire
correttamente la migrazione bot.

Codice A152

Messaggio Questo bot è stato migrato.

La dimensione delle variabili di tipo Array supera i
160.000. Alcune delle variabili di tipo Array sono migrate
come variabili di tipo Tabella in A360 senza i valori
predefiniti.

Il valore predefinito per la variabile di tipo Tabella può
essere richiesto affinché il bot dia gli stessi risultati.

Codice A154

Messaggio For the migrated bot to run, update the 'Simulate
keystrokes' action. The excel paste special behavior in A360
is different from the version 10.x/11.x. Message Code: A154

Causa The Paste Special dialog box varies between Automation 360, Enterprise 11,
and Enterprise 10. As a result, the Simulate keystrokes command functions
differently.

Azione Update the Simulate keystrokes command in the migrated bot.

Codice A155

Messaggio Affinché il bot migrato venga eseguito, aggiorna il nome
del bot nel comando Esegui attività. La logica di Metabot
è stata migrata aggiungendo il suffisso '-bot' al nome del
file

Causa Quando una Logic e una cartella nel MetaBot hanno lo stesso nome in Enterprise
11, dopo la migrazione, al nome del nome Logic è aggiunto il suffisso -bot in
modo che la Logic possa essere migrata.

Azione Aggiorna il nome bot nel comando Esegui attività.

Esaminare i messaggi richiesti

Questi messaggi vengono visualizzati nel report Bot Scanner, Bot Migration Wizard e in Migration Assistant
dopo la migrazione dei bots. In such cases, the bot is successfully migrated but you still have to manually
verify the migrated bots as described in the following messages.
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Codice R101
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Messaggi 1. Excel: L'azione Passa a foglio è stata migrata.

Esamina il nome e il tipo di sessione dell'azione per
verificare che il nome della sessione condivisa sia
corretto.

2. Excel: Close action has been migrated.

Esamina il nome e il tipo di sessione dell'azione per
verificare che il nome della sessione condivisa sia
corretto.

3. Excel: Delete cells action has been migrated.

Esamina il nome e il tipo di sessione dell'azione per
verificare che il nome della sessione condivisa sia
corretto.

4. Excel:L'azione Trova è stata migrata.

Esamina il nome e il tipo di sessione dell'azione per
verificare che il nome della sessione condivisa sia
corretto.

5. Excel: Get multiple cells action has been migrated.

Esamina il nome e il tipo di sessione dell'azione per
verificare che il nome della sessione condivisa sia
corretto.

6. Excel: Get single cells action has been migrated.

Esamina il nome e il tipo di sessione dell'azione per
verificare che il nome della sessione condivisa sia
corretto.

7. Excel: Get cell address action has been migrated.

Esamina il nome e il tipo di sessione dell'azione per
verificare che il nome della sessione condivisa sia
corretto.

8. Excel:L'azione Ottieni nome colonna è stata migrata.

Esamina il nome e il tipo di sessione dell'azione per
verificare che il nome della sessione condivisa sia
corretto.

9. Excel: Get row number action has been migrated.

Esamina il nome e il tipo di sessione dell'azione per
verificare che il nome della sessione condivisa sia
corretto.

10. Excel: Replace action has been migrated.
Esamina il nome e il tipo di sessione dell'azione per
verificare che il nome della sessione condivisa sia
corretto.

11. Excel: Run macro action has been migrated.
Esamina il nome e il tipo di sessione dell'azione per
verificare che il nome della sessione condivisa sia
corretto.

12. Excel:L'azione Salva cartella di lavoro è stata migrata.
Esamina il nome e il tipo di sessione dell'azione per
verificare che il nome della sessione condivisa sia
corretto.

13. Excel:L'azione Imposta cella è stata migrata.
Esamina il nome e il tipo di sessione dell'azione per
verificare che il nome della sessione condivisa sia
corretto.
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Codice R102

Messaggio La variabile di sistema Nome del sistema operativo è stata
migrata. Esamina il valore restituito per la variabile di
sistema Nome del sistema operativo nel bot migrato.

Il valore restituito dalla variabile di sistema Nome
del sistema operativo può essere diverso dalla versione
10.x/11.x.

Codice R103

Messaggio Clonazione dell'oggetto è stata migrata. Esamina l'azione
Riconoscimento delle immagini LeftClick nel bot migrato.

Migration of Object Cloning configured with play mode
Image with action MiddleClick has been migrated with Image
Recognition LeftClick action.

Codice R104

Messaggio L'azione Operazione stringa - Dividi è stata migrata.
Esamina l'azione Operazione stringa - Dividi nel bot
migrato.

The Limit field is now divided into 2 fields: All Options
and Only. Limit has been migrated to Only since it has a
variable.

Codice R105

Messaggio L'azione Integrazione app è stata migrata. Esamina il tipo
di applicazione Altro nel bot migrato.

È la migrazione dell'azione Integrazione app con il tipo di
applicazione Altro.

Codice R106

Messaggio L'azione OCR è stata migrata. Per ulteriori informazioni,
leggi la documentazione del pacchetto OCR Automation 360.

ABBYY è l'unico motore OCR supportato.

Causa Only the ABBYY OCR engine is supported with Automation 360. Irrespective of
which OCR engine you have been using in Enterprise 11, after migration your
bots will run using only the ABBYY OCR engine.

Azione Per ulteriori informazioni sul pacchetto OCR, consulta OCR package on page 1697.
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Codice R107

Messaggio L'azione E-mail - Connetti con Exchange Server è stata
migrata.

La versione di Exchange Server "Exchange 2013_SP1" viene
migrata come "Exchange 2013". Verifica che questa versione
di Exchange Server funzioni con il sistema.

Codice R114

Messaggio L'azione Emulatore di terminale - Connetti è stata migrata.

Il tipo di connessione è configurato come SSH2 poiché SSH1
non è supportato in A360.

Non sono richieste ulteriori azioni.

Causa Enterprise 11 e Enterprise 10 supportano entrambi i tipi di connessione SSH1
e SSH2. Automation 360 viene aggiornato per supportare solo il tipo di
connessione SSH2. However, your migrated bots that were configured with
SSH1 will work in Automation 360 and will be configured with the SSH2
connection type by default.

Codice R115

Messaggio L'azione Emulatore di terminale - Connetti è stata migrata.

Tutti i bot ora utilizzano l'impostazione Tecnologia
avanzata. Verifica e convalida il bot.

Causa In Enterprise 10 e Enterprise 11, puoi scegliere se utilizzare la tecnologia
avanzata per il comando Emulatore di terminale - Connetti. Poiché
Automation 360 viene aggiornato per supportare solo la Tecnologia avanzata,
per impostazione predefinita tutti i bots migrati verranno configurati con la
tecnologia avanzata per l'azione Emulatore di terminale Connetti.

Codice R116

Messaggio The value of the Error Description variable in the migrated
bot may be different from version 10.x / 11.x.

Esamina tutte le azioni che utilizzano il valore della
variabile Descrizione dell'errore.

Codice R117
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Messaggio Carico di lavoro: L'azione Inserisci elemento di lavoro è
stata migrata.

Il formato della data deve essere lo stesso nella versione
10.x/11.x e Automation 360.

Causa Il campo formato della data nel campo Carico di lavoro:L'azione Inserisci
elemento di lavoro utilizza un formato della data predefinito.

Azione If the date format is different from the global value AADefaultDateFormat,
update the required format in the Workload:Azione Inserisci elemento di
lavoro.

Codice R118

Messaggio L'azione Assegna ad Appunti è stata migrata.

La variabile di riferimento non esiste nella versione
10.x/11.x ed è stata migrata come stringa in Automation 360.

Il bot potrebbe non essere eseguito come previsto.

Codice R119

Messaggio L'azione Funzionamento variabili è stata migrata.

I tipi di variabile non corrispondono. La variabile è stata
disabilitata nel bot migrato.

Non sono richieste ulteriori azioni.

Causa In Enterprise 11, se si modifica il tipo di variabile (ad esempio, da stringa a
dizionario), il bot ignora la modifica e passa alla riga successiva. Tuttavia, in
Automation 360, la modifica della variabile non è supportata. So if there is a
change in variable type in the migrated bot, the variable is disabled to maintain
consistent behavior with Enterprise 11.
.

Codice R120

Messaggio L'azione "Attendi finestra" è stata migrata. Il valore
negativo della coordinata X1 è stato impostato su 0. Non
sono richieste ulteriori azioni.

Causa In Enterprise 10 e Enterprise 11, il valore negativo della coordinata X1 è
supportato per l'azione Attendi finestra. In Automation 360, il valore negativo
non è supportato, quindi il valore negativo del bot migrato è impostato su 0 per
impostazione predefinita.
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Codice R121

Messaggio L'azione "Attendi finestra" è stata migrata. Il valore
negativo della coordinata X2 è stato impostato su 0. Non
sono richieste ulteriori azioni.

Causa In the Enterprise 10 and Enterprise 11, the negative value for X2 coordinate was
supported for Wait for Window action. In Automation 360, the negative value
is not supported, so, negative value of the migrated bot is set to 0 by default.

Codice R122

Messaggio L'azione "Attendi finestra" è stata migrata. Il valore
negativo della coordinata Y1 è stato impostato su 0. Non
sono richieste ulteriori azioni.

Causa In Enterprise 10 e Enterprise 11, il valore negativo della coordinata Y1 è
supportato per l'azione Attendi finestra. In Automation 360, il valore negativo
non è supportato, e quindi il valore negativo del bot migrato è impostato su 0 per
impostazione predefinita.

Codice R123

Messaggio L'azione "Attendi finestra" è stata migrata. Il valore
negativo della coordinata Y2 è stato impostato su 0. Non
sono richieste ulteriori azioni.

Causa In Enterprise 10 e Enterprise 11, il valore negativo della coordinata Y2 è
supportato per l'azione Attendi finestra. In Automation 360, il valore negativo
non è supportato, e quindi il valore negativo del bot migrato è impostato su 0 per
impostazione predefinita.

Codice R124

Messaggio L'azione "Emulatore di terminale" è stata migrata.

Esamina il nome di sessione dell'azione per verificare che
il nome della sessione condivisa sia corretto.

Codice R125

Messaggio Recorder action has been migrated. The object properties
with value greater than 64kb have been truncated. Review
the object properties value in the 'Recorder' action of the
migrated bot. No action is required if those properties are
not used in the search criteria. Message code: R125
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Codice R126

Messaggio 'Window title regex has been migrated.

Review the Window title regex in the migrated bot if the
window is not found during Bot run.

Codice R127

Messaggio Il comando IfImageReco-FileInFile è stato migrato.

'.jpg, .jpeg, .jpe. .jfif, .bmp, .gif, .png' sono i formati
di file supportati per l'azione 'ImageFile1' del campo.

Codice R128

Messaggio La variabile con valore predefinito maggiore di 64 kb non è
supportata. Il valore viene memorizzato in un file di testo
e assegnato alla variabile durante l'esecuzione del bot.

Codice R129

Messaggio Questo bot è stato migrato.

Affinché il bot migrato possa essere eseguito, è necessaria
una variabile dizionario nella mappatura della variabile
di input dell'azione Esegui attività. Esamina la variabile
dizionario temporanea creata nel padre e mappata nella
variabile di input.

Codice R130

Messaggio L'azione 'Esegui attività' è stata migrata.

Una variabile di credenziale viene trasferita a una
variabile di tipo non credenziale in modo non protetto.
Per una maggiore protezione, trasferisci la variabile
credenziale a una variabile di tipo credenziale.

Non sono richieste ulteriori azioni.

Codice R133
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Messaggio L'azione con 'AAInstallationPath' è stata migrata.

Il valore di 'AAInstallationPath' nel bot migrato può essere
diverso dalla versione 10.x / 11.x.

Esamina tutte le azioni che utilizzano il valore dell'azione
'AAInstallationPath'.

Codice R134

Messaggio L'azione Esegui attività è stata migrata.

Il percorso bot figlio nell'azione Esegui attività viene
trasferito attraverso una variabile durante l'esecuzione.
Il valore della variabile dovrebbe passare per il percorso
corretto del bot figlio durante l'esecuzione del bot.

Codice R135

Messaggio L'azione Acquisisci schermata è stata migrata insieme
all'azione Registra su file per acquisire l'immagine e la
descrizione dell'errore.

Il percorso del file nell'azione Acquisisci schermata viene
trasferito attraverso una variabile durante l'esecuzione. Il
percorso del file nell'azione Registra su file è impostato
su $AAApplicationPath$/Temp/Error Handling/ErrorMessage.txt.
\
Non sono richieste ulteriori azioni.

Codice R136

Messaggio Metabot con logica è stato migrato.

Lo stesso nome è usato per la cartella delle risorse Metabot
o la cartella della logica nella versione 10.x/11.x. La
logica Metabot è stata migrata aggiungendo il suffisso
'-bot' al suo nome. Se qualsiasi altro bot esistente
corrisponde a questo nuovo nome, il bot sarà sovrascritto.

Esamina il bot migrato.

Code R137

Message Metabot with logic has been migrated.

This bot has been migrated. The migrated bot has a circular
dependency with another bot. Review the bot dependencies in
the migrated bot and update the missing dependencies.

Review the migrated bot.
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Codice R140

Messaggio The Value of the Error Line Number in the migrated bot may
be different from the one in version 10.x/11.x. Review any
action that uses the value of the Error Line Number in the
migrated bot. Message code:R140

Messaggi di errore

Questi messaggi vengono visualizzati nel report Bot Scanner e Bot Migration Wizard. Questi messaggi
vengono visualizzati quando la migrazione bot non viene eseguita correttamente.

Codice E101

Messaggio Questo bot non può essere migrato perché ha un bot figlio
che utilizza un'azione o una variabile di sistema non
supportata.

Causa Un bot figlio che utilizza un comando attualmente non supportato per la
migrazione non può essere migrato. Di conseguenza i bots padre che utilizzano
questo bot figlio non possono essere migrati.

Azione Per migrare questi bots padre, rimuovi i riferimenti al bot figlio dal bot padre ed
effettua poi la migrazione del bot padre.
Per visualizzare i comandi non supportati che sono utilizzati nel bots figlio, vai
all'elenco dei bots che non possono essere migrati e fai clic sul nome del bot
figlio.

Codice E104

Messaggio Questo bot non può essere migrato. The Object Cloning
command which automates Flash application is not supported
in Automation 360. Delete the Object Cloning command which
automates Flash application in Enterprise 10.x/Enterprise
11.x bot and then migrate. Message code: E104

Codice E106

Messaggio Questo bot non può essere migrato.

La migrazione di MetaBot con schermate che hanno la modalità
di riproduzione come testo non è ancora supportata.

Note:  This message is applicable only for Automation 360 v.25 and earlier
releases.
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Codice E109

Messaggio Questo bot non può essere migrato.

La migrazione della chiamata API REST utilizzando il
servizio web SOAP con l'autenticazione mediante certificato
client non è ancora supportata.

Codice E110

Messaggio Questo bot non può essere migrato.

La migrazione del tipo di dati OCTET DECIMAL BYTE STRING al
momento non è supportata.

Codice E112

Messaggio Questo bot non può essere migrato.

La migrazione della chiamata API REST utilizzando l'azione
del Servizio Web SOAP con XML esterno non è ancora
supportata.

Codice E113

Messaggio Questo bot non può essere migrato.

La migrazione della chiamata API REST utilizzando l'azione
del Servizio Web SOAP con XML interno non è ancora
supportata.

Codice E114

Messaggi 1. Questo bot non può essere migrato.

La migrazione dell'azione VariableOperation -
ResetSysVariable non è ancora supportata.

2. Questo bot non può essere migrato.

La migrazione dell'azione di Internet - IntCon non è
ancora supportata.

Codice E115
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Messaggio Questo bot non può essere migrato.

La migrazione dell'azione Funzionamento variabili che
reimposta la variabile di sistema $WorkItem$ non è
supportata.

Il ripristino della variabile di sistema $WorkItem$ non è supportato per il
comando Funzionamento variabili.

Utilizza l'operazione Stringa > Assegna e assegna una stringa vuota alla
variabile di sistema $WorkItem$ invece di reimpostarla.

Codice E116

Messaggio Questo bot non può essere migrato.

La migrazione dell'azione Funzionamento variabili che
reimposta la variabile di sistema $WorkItemResult$ non è
supportata.

Causa Il ripristino della variabile di sistema $WorkItemResult$ non è supportato per il
comando Funzionamento variabili.

Azione Utilizza l'operazione Stringa > Assegna e assegna una stringa vuota alla
variabile di sistema $WorkItemResult$ invece di reimpostarla.

Codice E118

Messaggio Crea la Credenziale o l'Armadietto in Automation 360 prima
di migrare questo bot versione 10.x/11.x.

Impossibile migrare le variabili delle credenziali
di MetaBot-DLL perché la Credenziale o l'Armadietto
corrispondente non è presente in Control Room.

Causa La variabile Credenziale associata non viene migrata per MetaBot-DLL perché
la credenziale o l'armadietto associati non sono presenti in Enterprise 11 Control
Room.

Azione Crea manualmente la credenziale o l'armadietto in Automation 360 e quindi migra
il bot.

Codice E119
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Messaggio Questo bot ha un percorso non valido.

Modifica il percorso del bot nella versione 10.x/11.x e
assicurati che il bot venga eseguito prima di procedere con
la migrazione.

Il percorso definito nell'azione Esegui attività utilizzando
$AAApplicationPath$ non si trova in una cartella di archivio
valida.

Causa Il bot Enterprise 11 o Enterprise 10 utilizza un percorso non valido nel comando
Esegui attività del bot figlio.

Azione Per eseguire la migrazione di questo bot, modifica il bot Enterprise 11 per
garantire un percorso valido per il bot figlio dopo AAApplicationPath.

Codice E120

Messaggio Questo bot ha un percorso non valido.

Modifica il percorso del bot nella versione 10.x/11.x e
assicurati che il bot venga eseguito prima di procedere con
la migrazione.

Il percorso definito nell'azione If - TaskSuccessful
utilizzando $AAApplicationPath$ non si trova in una cartella
di archivio valida.

Causa Il bot Enterprise 11 o Enterprise 10 utilizza un percorso non valido nel comando
If - TaskSuccessful del bot figlio.

Azione Per eseguire la migrazione di questo bot, modifica il bot Enterprise 11 per
garantire un percorso valido per il bot figlio dopo AAApplicationPath.

Codice E121

Messaggio Questo bot ha un percorso non valido.

Modifica il percorso del bot nella versione 10.x/11.x e
assicurati che il bot venga eseguito prima di procedere con
la migrazione.

Il percorso definito nell'azione If - TaskUnsuccessful
utilizzando $AAApplicationPath$ non si trova in una cartella
di archivio valida.

Causa Il bot Enterprise 11 o Enterprise 10 utilizza un percorso non valido nel comando
If - TaskUnsuccessful del bot figlio.

Azione Per eseguire la migrazione di questo bot, modifica il bot Enterprise 11 per
garantire un percorso valido per il bot figlio dopo AAApplicationPath.
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Codice E122

Messaggio Questo bot ha un percorso non valido.

Modifica il percorso del bot nella versione 10.x/11.x e
assicurati che il bot venga eseguito prima di procedere con
la migrazione.

Il percorso definito nell'azione ElseIf - TaskUnsuccessful
utilizzando $AAApplicationPath$ non si trova in una cartella
di archivio valida.

Causa Il bot Enterprise 11 o Enterprise 10 utilizza un percorso non valido nel comando
ElseIf - TaskUnsuccessful del bot figlio.

Azione Per eseguire la migrazione di questo bot, modifica il bot Enterprise 11 per
garantire un percorso valido per il bot figlio dopo AAApplicationPath.

Codice E123

Messaggio Questo bot ha un percorso non valido.

Modifica il percorso del bot nella versione 10.x/11.x e
assicurati che il bot venga eseguito prima di procedere con
la migrazione.

Il percorso definito nell'azione ElseIf - TaskSuccessful
utilizzando $AAApplicationPath$ non si trova in una cartella
di archivio valida.

Causa Il bot Enterprise 11 o Enterprise 10 utilizza un percorso non valido nel comando
ElseIf - TaskSuccessful del bot figlio.

Azione Per eseguire la migrazione di questo bot, modifica il bot Enterprise 11 per
garantire un percorso valido per il bot figlio dopo AAApplicationPath.

Codice E124

Messaggio Il valore trasferito alla funzione DLL è in un formato non
valido.

Modifica il bot nella versione 10.x/11.x prima di eseguire
la migrazione.

Convalida la variabile array/list e il valore matrice/lista
trasferito nella funzione DLL e aggiorna il bot 10.x/11.x.

Codice E125
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Messaggio Modifica il bot nella versione 10.x/11.x prima di eseguire
la migrazione.

Aggiorna il bot della versione 10.x/11.x affinché includa le
variabili di riferimento dell'azione Assegna dagli Appunti.
Impossibile trovare una variabile di riferimento.

Codice E127

Messaggio Modifica il bot nella versione 10.x/11.x prima di eseguire
la migrazione.

I tipi di variabili non corrispondono o sono stati
modificati.

Aggiorna il tipo di variabile nell'azione Funzionamento
variabili nel bot versione 10.x/11.x.

Codice E128

Messaggio Questo bot non può essere migrato.

La migrazione di "MetaBot con schermate" utilizzando la
tecnologia Silverlight non è ancora supportata.

Codice E129

Messaggio Questo bot non può essere migrato.

La migrazione di "MetaBot con schermate" acquisite
utilizzando il browser Edge non è ancora supportata.

Codice E130

Messaggio Questo bot non può essere migrato.

La migrazione di "MetaBot con schermate" acquisite
utilizzando il browser Firefox non è ancora supportata.

Codice E131

Messaggio Questo bot non può essere migrato.

La migrazione di "MetaBot con schermate" con l'azione
"GetAllChildrenData" non è ancora supportata.

Codice E132
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Messaggio Questo bot non può essere migrato.

La migrazione di "MetaBot con schermate" con l'azione
"GetVisibility" non è ancora supportata.

Codice E133

Messaggio Questo bot non può essere migrato.

La migrazione di "MetaBot con schermate" con oggetti
collegati non è ancora supportata.

Codice E134

Messaggio Questo bot non può essere migrato.

La migrazione di "MetaBot con schermate" con "modalità di
riproduzione come coordinate per oggetti collegati" non è
ancora supportata.

Codice E135

Messaggio Questo bot non può essere migrato.

La migrazione di "MetaBot con schermate" con "modalità di
riproduzione come immagine per oggetti collegati" non è
ancora supportata.

Codice E136

Messaggio Questo bot non può essere migrato.

La migrazione dell'azione "Clonazione dell'oggetto" con il
browser Edge non è ancora supportata.

This bot cannot be migrated. The Object Cloning command
which automates Legacy Edge browser is not supported in
Automation 360 . Delete the object cloning command which
automates Edge Legacy browser in 10.x/11/x bot and then
migrate. Message code: E136

Codice E137

Messaggio Questo bot non può essere migrato.

La migrazione dell'azione "Clonazione dell'oggetto" con il
browser Firefox non è ancora supportata.
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Codice E138

Messaggio Questo bot non può essere migrato.

La migrazione dell'azione "Clonazione dell'oggetto" con
Silverlight non è ancora supportata.

Codice E139

Messaggio Questo bot non può essere migrato.

La migrazione dell'azione "Clonazione dell'oggetto" con
l'azione "GetDataofAllchildren" non è ancora supportata.

Codice E140

Messaggio Questo bot non può essere migrato.

La migrazione dell'azione "Emulatore di terminale -
Connetti" con "Pagina codice (50939) giapponese" non è
ancora supportata.

Codice E141

Messaggio Questo bot non può essere migrato.

La migrazione dell'azione "Emulatore di terminale -
Connetti" con "Pagina codice (51932) giapponese" non è
ancora supportata.

Codice E142

Messaggio Questo bot non può essere migrato.

La migrazione dell'azione "Emulatore di terminale -
Connetti" con "Pagina codice (20932) giapponese JIS" non è
ancora supportata.

Codice E143

Messaggio Questo bot non può essere migrato.

La migrazione dell'azione "Emulatore di terminale -
Connetti" con "Pagina codice (50220) giapponese JIS" non è
ancora supportata.

Codice E144
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Messaggio Questo bot non può essere migrato.

La migrazione dell'azione "Emulatore di terminale -
Connetti" con "Pagina codice (50221) giapponese JIS" non è
ancora supportata.

Codice E145

Messaggio Questo bot non può essere migrato.

La migrazione dell'azione "Emulatore di terminale -
Connetti" con "Pagina codice (50222) giapponese JIS" non è
ancora supportata.

Codice E146

Messaggio Questo bot non può essere migrato.

La migrazione dell'azione "Emulatore di terminale -
Connetti" con "Pagina codice (50930) giapponese katakana"
non è ancora supportata.

Codice E147

Messaggio Questo bot non può essere migrato.

La migrazione dell'azione "Emulatore di terminale -
Connetti" con "Pagina codice (20290) giapponese katakana
esteso" non è ancora supportata.

Codice E148

Messaggio Questo bot non può essere migrato.

La migrazione dell'azione "Emulatore di terminale -
Connetti" con '"USA-Canada e giapponese (50931)" non è
ancora supportata.

Codice E149

Messaggio Questo bot non può essere migrato.

La migrazione del comando Walk con tipo Tutti non è
supportata.

Codice E150
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Messaggio Questo bot non può essere migrato.

Il Meta Bot di riferimento non è disponibile nella posizione
fornita. Fornisci il Meta Bot valido o la posizione valida
nella versione 10.x /11.x e riprova.

Codice E151

Messaggio Questo bot non può essere migrato.

La migrazione dell'azione $IsCognitiveCaptureSuccess$ non è
supportata.

Codice E152

Messaggio Questo bot non può essere migrato.

Modifica la variabile del tipo di password nel bot della
versione 10.x/11.x prima di eseguire la migrazione.

La migrazione del comando con la variabile di tipo Password
non è supportata. Questa azione non supporta la variabile
archivio credenziali.

Codice E153

Messaggio Questo bot non può essere migrato.

Modificare il tipo di variabile del campo d'azione
SMARTWndCtrl nel bot versione 10.x/11.x prima di eseguire la
migrazione.

La migrazione dell'azione SMARTRecorder SMARTWndCtrl con
campo 'SetDateRange_NotSupportedAction' di tipo 'String' non
è supportata.

Codice E154

Messaggio Questo bot non può essere migrato.

The migration of 'MetaBot with Screens' with 'play mode as
image for linked objects' and 'play mode as object for main
objects' is not yet supported.

Codice E155
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Messaggio Questo bot non può essere migrato.

The migration of 'MetaBot with Screens' with 'play mode as
image for linked objects' and 'play mode as text for main
objects' is not yet supported.

Codice E156

Messaggio Questo bot non può essere migrato.

The migration of 'MetaBot with Screens' with 'play mode as
object for linked objects' and 'play mode as image for main
objects' is not yet supported.

Codice E157

Messaggio Questo bot non può essere migrato.

The migration of 'MetaBot with Screens' with 'play mode as
object for linked objects' and 'play mode as text for main
objects' is not yet supported.

Codice E159

Messaggio Questo bot non può essere migrato.

The migration of 'MetaBot with Screens' with 'play mode as
text for linked objects' and 'play mode as object for main
objects' is not yet supported.

Codice E160

Messaggio Questo bot non può essere migrato.

The migration of 'MetaBot with Screens' with 'play mode as
text for linked objects' and 'play mode as text for main
objects' is not yet supported.

Codice E160

Messaggio Questo bot non può essere migrato.

The migration of 'MetaBot with Screens' with 'play mode as
coordinate for linked objects' and 'play mode as text for
main objects' is not yet supported.

Codice E163
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Messaggio Network Error: Migration failed due to loss of connectivity
between Control Room and Bot Runner machine.

Codice E164

Messaggio Questo bot non può essere migrato.

The migration of 'MetaBot with Screens' with 'play mode as
text' and having Import Dataset command with action other
than GetText, SetText, DoubleClick, LeftClick and RightClick
is not yet supported.

Codice E165

Messaggio Questo bot non può essere migrato.

The migration of 'MetaBot with Screens' with 'play mode
as text' and having any OCR engine other than 'Abbyy' or
'Tesseract' will use 'Abbyy' OCR engine after migration.

Messaggi sulla conversione o scansione Internet Explorer

Questi messaggi sono visualizzati nel report Bot Scanner quando i bots che utilizzano Internet Explorer
vengono eseguiti o scansionati e non vengono migrati correttamente su altri browser supportati.

Codice R1001

Messaggio Nella proprietà 'Posizione del programma/file' di questo
bot è usata una variabile. Se la variabile punta a Internet
Explorer, aggiornala in modo che punti invece al browser
Microsoft Edge basato su Chromium. In caso contrario, non
sono necessarie ulteriori azioni.

Codice R1002

Messaggio I componenti del browser come la barra dei menu, la barra
di stato, la barra dei preferiti, la barra dei comandi e
altri componenti che non appartengono ella pagina web sono
diversi in ogni browser, e questo può potenzialmente avere
un impatto sulle schermate acquisite in <PACKAGE_NAME -
ACTION_NAME>.

Si consiglia di rivedere e acquisire nuovamente le
schermate, se necessario.

Codice R1003
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Messaggio RegEx variable used in the window title seems to have
partial text corresponding to 'Internet Explorer' hence the
title may not get converted as per 'Microsoft Edge' text
that is used in the Edge browser window.

Si consiglia di utilizzare il testo 'Internet Explorer' per
intero nella variabile RegEx.

Differences while migrating APIs from Enterprise 11/Enterprise 10
to Automation 360
When you migrate from Enterprise 11 to Automation 360, review any Control Room APIs migration issues
and their workarounds.
One difference between the Enterprise 11 and Automation 360 versions occurs in the Credential Value
API - Get attributevalues.

GET https://{{ControlRoomURL}}/v2/credentialvault/credentials/
{credentialId}/attributevalues

In Automation 360, the CredentialAttribute object is not available in the response of GET
 attributevalues API. If you are using any parameters in this object in your bot logic then you must
modify your response parsing logic and use GET /v2/credentials/{id} (See Credential Vault API ) to
consume those parameters.
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Sample responses for the GET attributevalues for both Enterprise 11 and Automation 360 versions:

Enterprise 11 Automation 360

{
 {
  "list": [{
    "id": "2221",
    "credentialAttributeId":
 "9271",
    "value": "LNC2021132D",
    "createdBy": "21",
    "createdOn":
 "2021-09-29T12:37:48.765Z",
    "updatedBy": "131",
    "updatedOn":
 "2021-10-18T20:47:58.027Z",
    "version": "3",
    "credentialAttribute": {
      "id": "2277",
      "name": "ABCD_Account",
      "description": "",
      "userProvided": false,
      "masked": false,
      "createdBy": "77",
      "createdOn":
 "2021-09-29T12:37:48.638Z",
      "updatedBy": "77",
      "updatedOn":
 "2021-09-29T12:37:48.638Z",
      "version": "0",
      "passwordFlag": false
    }
  }]
}

{
  "list": [{
    "id": "4008",
    "credentialAttributeId":
 "1622",
    "value": "LNC2021132D",
    "createdBy": "21",
    "createdOn":
 "2021-09-29T12:37:48.765Z",
    "updatedBy": "274",
    "updatedOn":
 "2021-10-18T20:47:58.027Z",
    "version": "3",
    "password": false
  }]
}

Esegui la migrazione Community Edition bots
Bots creato nell'ambiente Enterprise 11 Community Edition deve essere migrato a Automation 360
Community Edition per consentire agli utenti di utilizzarli bots in Automation 360. Puoi utilizzare il Bot
pacchetto di migrazione disponibile in Automation 360 Community Edition per migrare manualmente bots.
Prima di iniziare la migrazione di bots, procedi come segue:
• Utilizza l'utilità Bot Scanner per determinare se è possibile eseguire correttamente la migrazione di

Enterprise 11 bots.
Panoramica di Bot Scanner on page 1158

• Ottieni l'accesso a Automation 360 Community Edition.
• Registra un dispositivo in Automation 360 Community Edition per eseguire bots.

Installazione di Bot Agent e registrazione del dispositivo on page 1039

Questa procedura migra una bot alla volta. Per eseguire la migrazione di tutti i bots all'interno della stessa
cartella, puoi creare un bot complesso iterando i file in una cartella in un loop o aggiungere più azioni
Esegui la migrazione del bot per ogni file .atmx che desideri migrare.
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Important:  Se un bot ha dipendenze su altri bots, devi prima migrare il bots dipendente e quindi il bot
genitore. Ad esempio, il padre bot main.atmx ha una dipendenza da child1.atmx, che ha a sua volta
una dipendenza da child2.atmx, quindi aggiungi le azioni Esegui la migrazione del bot nel seguente
ordine: child2.atmx, seguito da{{child1.atmx}} e poi {{main.atmx}}.

1. Accedi a Automation 360 Community Edition.
2. Utilizza il Bot pacchetto di migrazione per migrare il tuo bots.

a) Click Automation on the left pane.
b) Click Create New > Bot, specify the required details, and click Create & edit.
c) Espandi il pacchetto Migrazione bot e fai doppio clic sull'azione Esegui la migrazione del bot.
d) Seleziona File desktop nella sezione Percorso file bot.
e) Immetti il percorso completo del file Enterprise 11 .atmx da migrare.
f) Optional: Immetti il percorso della cartella di output nel campo Percorso cartella di output per

specificare dove desideri che vengano archiviati gli errori e le informazioni sulla conversione del
pacchetto.
Viene generato un report che mostra le informazioni pertinenti per ogni bot migrato.

g) Lascia selezionata l'opzione Sovrascrivi il file se esiste (impostazione predefinita) se
desideri che questa azione di migrazione bot sovrascriva uno qualsiasi bots dello stesso nome
nell'ambiente Automation 360 Community Edition.

h) Salva il bot.
i) Esegui bot sul dispositivo connesso per eseguire la migrazione.

La migrazione di bots viene caricata correttamente nell’archivio Automation 360 privato dell'utente che
ha eseguito la migrazione. Viene eseguita solo la migrazione dei bots migrati correttamente. Utilizza
i report nel Percorso della cartella di output specificato per visualizzare gli errori di migrazione.

Related tasks
Scan Enterprise 11 or 10 bots using Bot Scanner on page 1160
Prima di eseguire la migrazione a Automation 360 devi verificare lo stato di preparazione alla migrazione
dei bots. Esegui la scansione dei bots utilizzando Bot Scanner e analizza il report generato per informazioni
sui comandi e le variabili utilizzati in questi bots e su quanti di questi comandi e variabili sono supportati
per la migrazione.
Related reference
Bot migration package on page 1424
The Bot migration package enables you to migrate Enterprise 10 and Enterprise 11 bots to Automation
360 format. The package also enables you to convert Enterprise 10, Enterprise 11, or Automation 360
bots that use Internet Explorer to Microsoft Edge with IE mode. This package is used internally by the Bot
Migration Wizard and the Update Bot wizard.

Migrazione a Automation 360 IQ Bot
La migrazione è il processo di aggiornamento dalle versioni precedenti di IQ Bot (Enterprise 11.x, 6.x o
5.x) alla versione Automation 360 IQ Bot più recente. Questa procedura include la replica del database e
dell’archivio esistenti, la conversione dei bots in formato Automation 360 e la migrazione di tutte le istanze
di apprendimento.
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Controlla la preparazione alla migrazione

Le caratteristiche e le funzionalità di Automation 360 IQ Bot sono le stesse di IQ Bot Enterprise 11. Il
contenuto di Enterprise 11 esistente si applica anche a Automation 360 IQ Bot.
• Puoi effettuare l'aggiornamento a qualsiasi versione di Automation 360 IQ Bot senza alcuna restrizione.

Tuttavia, assicurati di utilizzare l'Assistente migrazione del database della versione di destinazione da
migrare.
Ad esempio, se desideri migrare a Automation 360 IQ Bot (Build 11513), devi utilizzare l'Assistente
migrazione del database per Automation 360 IQ Bot (Build 11513), che è disponibile come utility
separata nella cartella di installazione di Automation 360 IQ Bot.

• Confronta alcune delle caratteristiche chiave dei modelli di distribuzione Automation 360 IQ Bot con la
versione IQ Bot.
Matrice di confronto delle funzionalità per Automation 360 IQ Bot on page 735

• Esamina le informazioni sulla compatibilità delle versioni di IQ Bot.
Compatibilità delle versioni di Automation 360 IQ Bot on page 740

• Obtain the migration license: Ottenere la licenza di migrazione on page 1172
• Prima di eseguire la migrazione da IQ Bot 11.x a Automation 360 IQ Bot On-Premises, assicurati di

aver scaricato la versione più recente di Database Migration Assistant dal sito di supporto Automation
Anywhere.
Questo strumento consente di eseguire la migrazione dei dati ed è supportato sulle seguenti versioni di
Microsoft SQL Server:
• Microsoft SQL Server 2019 15.0 Developer Edition ed Express Edition
• Microsoft SQL Server 2016 13.0 Express Edition
• Microsoft SQL Server 2012 Express Edition

Note:  L'Assistente migrazione di database non supporta Azure PaaS Database Service. Se utilizzi Azure
PaaS Database Service, devi copiare tutti i database IQ Bot in una delle versioni supportate sopra ed
eseguire l'Assistente migrazione del database. I database unificati creati con l'Assistente migrazione di
database possono quindi essere caricati nuovamente su Azure PaaS Database Service.

• Se si sta effettuando la migrazione da IQ Bot 11.x a Automation 360 IQ Bot On-Premises, si consiglia di
disporre di un cluster a 3 nodi per garantire un'elevata disponibilità (HA) per IQ Bot.
High availability and disaster recovery overview

• Per il ripristino di emergenza (DR) RabbitMQ v3.8.18, si consiglia di avere lo stesso numero di nodi nei
siti primario e secondario per ottenere la stessa capacità di gestione del carico.
Analogamente, la configurazione del cluster RabbitMQ v3.8.18 del sito secondario deve replicare la
configurazione del cluster del sito primario.
Disaster recovery deployment model

Per la configurazione del cluster RabbitMQ v3.8.18 con ripristino automatico, vedi RabbitMQ Cluster
Configuration with Auto-recovery (A-People login required)

Scelta del percorso di migrazione

Puoi scegliere il percorso di migrazione in base alla versione di IQ Bot attualmente in uso e al modello di
distribuzione di Automation 360 IQ Bot che soddisfa i requisiti della tua azienda.
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Important:  Nelle versioni IQ Bot precedenti, sono stati creati cinque database e in Automation 360 IQ
Bot è stato creato un unico database unificato. Assicurati quindi di eseguire il backup dei database IQ Bot
esistenti prima di avviare la migrazione.

Versione attualmente in uso Procedura di migrazione da utilizzare

IQ Bot 11.3.4 (o successiva) Migrazione a Automation 360 IQ Bot On-Premises o a Cloud:
1. Migrazione delle versioni precedenti di IQ Bot a Automation 360 IQ

Bot On-Premises on page 1344
2. Migrazione da Automation 360 IQ Bot On-Premises a Cloud on

page 1346
Installa la versione di Automation 360 IQ Bot On-Premises più
recente prima di eseguire la migrazione a IQ Bot Cloud.

IQ Bot 6.5.x Puoi eseguire la migrazione a Automation 360 IQ Bot On-Premises
solo da IQ Bot Version 11.3.4.
1. Aggiorna IQ Bot Version 6.5 a IQ Bot Version 11.3.4

Update IQ Bot from 6.5 or earlier to 11.3.4

2. Migrazione delle versioni precedenti di IQ Bot a Automation 360 IQ
Bot On-Premises on page 1344

3. Migrazione da Automation 360 IQ Bot On-Premises a Cloud on
page 1346
Installa la versione di Automation 360 IQ Bot On-Premises più
recente prima di eseguire la migrazione a IQ Bot Cloud.

IQ Bot 5.3.x (o versioni
precedenti)

1. Aggiorna a IQ Bot Version 6.5
Update IQ Bot from 5.3.x or 6.0 to 6.5

2. Aggiorna IQ Bot Version 6.5 a Version 11.3.4
Update IQ Bot from 6.5 or earlier to 11.3.4

3. Migrazione delle versioni precedenti di IQ Bot a Automation 360 IQ
Bot On-Premises on page 1344

4. Migrazione da Automation 360 IQ Bot On-Premises a Cloud on
page 1346
Installa la versione di Automation 360 IQ Bot On-Premises più
recente prima di eseguire la migrazione a IQ Bot Cloud.

Related concepts
Installazione e aggiornamento Automation 360 IQ Bot on page 1066
This collection of topics guide you through the process of installing or setting up Automation 360 IQ Bot
On-Premises and Cloud.
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Prepare for IQ Bot migration
Perform these tasks before you migrate to Automation 360 IQ Bot (On-Premises) from an earlier IQ Bot
version (from Enterprise 6.x through 11.x).
1. Se stai attualmente utilizzando una delle versioni di Automation Anywhere Enterprise precedenti (10.x

o 11.x), assicurati di eseguire la migrazione alla versione Automation 360 più recente.
Migrazione a Automation 360 on page 1126

2. Assicurati che la versione di Automation 360 corrisponda alla versione di Automation 360 IQ Bot che
stai installando.
Compatibilità delle versioni di Automation 360 IQ Bot on page 740

3. Esegui la migrazione alle versioni più recenti di Automation 360 IQ Bot On-Premises da IQ Bot Version
11.3.4 o versioni successive. Se stai attualmente utilizzando una delle versioni precedenti di IQ Bot
(5.3.x), è necessario prima eseguire queste operazioni:
a) Eseguire l’aggiornamento a IQ Bot Version 6.5.

Vedi Update IQ Bot from 5.3.x or 6.0 to 6.5

b) Eseguire l’aggiornamento di IQ Bot Version 6.5 a IQ Bot Version 11.3.4 prima di eseguire la
migrazione a Automation 360 IQ Bot On-Premises.
Vedi Update IQ Bot from 6.5 or earlier to 11.3.4

4. Eseguire il backup dei database IQ Bot esistenti.
Nelle versioni precedenti di IQ Bot venivano creati cinque database. Con Automation 360 IQ Bot On-
Premises Build 2545 viene creato un singolo database unificato.
a) Assicurati di eseguire il backup di tutti e cinque i database:

• AliasData
• ClassifierData
• Configurations
• FileManager
• MLData

b) Disinstalla le versioni precedenti di IQ Bot
La disinstallazione di una build IQ Bot esistente non elimina il database.
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5. Installa Database Migration Assistant.
a) Accedi al sito di supporto Automation Anywhere e scarica Database Migration Assistant:

A-People Downloads page (Login required)

Note:  Ensure that OBDC Driver version 17.0 for SQL Server is available on your system
before you run the Database Migration Assistant.

b) Double-click the file to run Database Migration Assistant.
c) Click Next to continue.
d) Accept the license agreement. and click Next.
e) Nella schermata Configurazione database immetti il nome host e le credenziali del database IQ

Bot esistente e fai clic su Avanti.

Note:  Il servizio browser SQL Server deve essere in esecuzione se desideri utilizzare il nome
completo del SQL Server come nome host.

f) (Optional) Click Browse to change the default installation folder for the Database Migration
Assistant.

g) Fai clic su Installa.
Al termine dell'installazione, viene creato un nuovo database denominato IQBot. Puoi utilizzare il
seguente percorso per esaminare i file di registro:
C:\Users\Public\Documents\Migration_Assistant_Logs

Note:  Una volta completata la migrazione a Automation 360 IQ Bot, i file di output elaborati in IQ Bot
11x non saranno disponibili per il download tramite il IQ Bot package in Control Room.
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Migrazione delle versioni precedenti di IQ Bot a Automation 360 IQ
Bot On-Premises
Eseguire la migrazione da una versione IQ Bot precedente (da Enterprise 6.x a 11.x) a Automation 360 IQ
Bot (On-Premises) per le funzionalità e i miglioramenti più recenti.
1. Download Automation 360 IQ Bot

a) Accedi al sito di supporto di Automation Anywhere per scaricare e installare la build di Automation
360 IQ Bot più recente:
A-People Downloads page (Login required)

b) Estrai (decomprimi) la cartella Automation_Anywhere_IQ_Bot_A2019_(numero di build) ed
esegui i seguenti file .bat:
1. CleanupRabbitMQandErlang.bat

2. CleanupRabbitMQErlangPython.bat

3. UninstallPython.bat

4. UninstallPython385.bat

Questi file rimuovono le voci di registro di RabbitMQ v3.8.18, Erlang/OTP pertinenti IQ Bot
Python. Nessun altra versione Python risulta interessata.

c) Riavvia il computer.

2. Install Automation 360 IQ Bot
a) Apri la cartella Automation_Anywhere_IQ_Bot_A2019_(numero di build) ed esegui

nuovamente i seguenti file:
1. CleanupRabbitMQandErlang.bat

2. CleanupRabbitMQErlangPython.bat

3. UninstallPython.bat

4. UninstallPython385.bat

This procedure removes any empty folders from RabbitMQ v3.8.18, Erlang, and Python.
b) Installa la build Automation 360 IQ Bot.
c) Durante l'installazione, specifica lo stesso nome host in cui è stato creato il database IQBot.

Automation 360 IQ Bot si connette automaticamente al database IQBot creato da Database
Migration Assistant prima della migrazione dei dati.

d) Al termine dell'installazione, annulla la registrazione di IQ Bot Enterprise 11.
Unregistering IQ Bot from the Control Room

Automation 360 IQ Bot si connette automaticamente al database IQBot creato da Database
Migration Assistant prima della migrazione dei dati.

e) Cancella la cache del browser.
f) (Optional) Restart the Cognitive Console service if IQ Bot fails to load.
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3. Register Automation 360 IQ Bot
a) Register IQ Bot A360.x with the Control Room.

x si riferisce alla versione più aggiornata di Automation 360 IQ Bot.
Registering IQ Bot with the Control Room

Troubleshooting:
• Se la pagina di accesso non viene visualizzata dopo la registrazione di IQ Bot A360.x, riavvia i

servizi Control Room (Control Room e proxy inverso Control Room).
• Se nessuno dei domini o dei dashboard viene visualizzato quando accedi a Automation 360 IQ

Bot dopo una migrazione riuscita, procedi nel modo seguente:
• Premi il tasto F12 e fai clic sulla scheda Rete per visualizzare le API.

Se le API non sono autorizzate o viene visualizzato un messaggio di errore, riavvia il
servizio IQ Bot.

• Se i bots non sono visualizzati nelle istanze di apprendimento, cancella la cache del
browser.

b) After the registration, restart the Automation Anywhere Cognitive Application service.

4. Modify the output file name
a) Dopo la migrazione dei dati, assicurati di modificare il nome del file .csv di output.

Il file .csv di output in Automation 360 IQ Bot contiene caratteri aggiuntivi. If you are using the
download command, use the following instructions to edit the output .csv filename:
• Rimuovi le parentesi quadre [ ].
• Sostituisci il carattere di sottolineatura (_) con un trattino (–).
• Sostituisci gli spazi con il carattere di sottolineatura (_).

Ad esempio, se il nome del file .csv di output è [sales-7d6 961f3d28]_Invoice.tiff,
rinominalo come sales-7d6_961f3d28-Invoice.tiff.

5. Verify the migrated data
a) Log in to the Automation 360 IQ Bot as a newly created IQ Bot user.
b) Review the data displayed on the Dashboard to ensure that the IQ Bot 11.3.x data has been

migrated.
c) You can also verify the migrated data by checking the following pages:

• Istanze di apprendimento
• Domini
• Bot Pages

Ensure that the current OCR version is supported in Automation 360 IQ Bot.
• ABBYY FineReader Engine - 12.2, 12.3, or 12.4 (use the version provided in the installation folder)

Note:  To upgrade the OCR version, download the OCR package to the installation folder.

• Tesseract OCR - 4
• Google Vision API - version is updated automatically to match current release
• Microsoft Azure Computer Vision OCR engine - 2.0 or 3.2
• Tegaki API - check with your Cogent Labs sales representative
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Related information
IQ Bot migration with keys stored in external vault (Login required)

Migrazione da Automation 360 IQ Bot On-Premises a Cloud
IQ Bot Cloud offre tutte le funzionalità di Automation 360 IQ Bot On-Premises tramite un'interfaccia basata
su browser.
• Eseguire la migrazione della Control Room prima di eseguire la migrazione a IQ Bot Cloud. Se la Control

Room è disponibile su Cloud, è possibile eseguire la migrazione a IQ Bot Cloud.
• Installa la versione più recente di Automation 360 IQ Bot On-Premises prima di eseguire la migrazione a

IQ Bot Cloud.
Consulta Migrazione delle versioni precedenti di IQ Bot a Automation 360 IQ Bot On-Premises on page 1344.

• Verifica che sia disponibile un'istanza IQ Bot Cloud attiva con la stessa versione.
• Se i dati di registrazione IQ Bot non sono corretti, rimuoverli prima di creare i dati di registrazione

corretti.

Tenere presente le seguenti considerazioni quando si esegue la migrazione da Automation 360 IQ Bot On-
Premises a IQ Bot Cloud:
• IQ Bot Cloud è un'istanza a nodo singolo.

Prima di iniziare la migrazione, verifica i requisiti di elaborazione dei documenti e di concorrenza. La
configurazione del cluster non è supportata su IQ Bot Cloud.

• Impossibile accedere ai file di configurazione in IQ Bot Cloud.
Le impostazioni OCR personalizzate nei file di configurazione devono essere caricate nel database
Automation 360 IQ Bot On-Premises prima della migrazione.
How to change OCR Settings in IQ Bot (A-People login required)

• Lo scripting Python è limitato a librerie specifiche su IQ Bot Cloud.
File Python specifici del cliente, librerie specifiche e metodologie non sono consentiti in IQ Bot Cloud.
List of supported Pandas Libraries in Automation 360 IQ Bot (A-People login required)

• L'impostazione RBAC (Role-Based Access Control) configurata su Automation 360 IQ Bot On-Premises
non viene migrata su IQ Bot Cloud.
Consulta RBAC in Control Room on page 31.

• Trasferisci i file .iqba in IQ Bot Cloud.
Tutti i ruoli personalizzati creati vengono rimossi prima della creazione dei file .iqba. Assicurati di
aggiungere questi ruoli dopo aver trasferito i file .iqba in IQ Bot Cloud.

Gli utenti hanno le seguenti opzioni per caricare il file .iqba su IQ Bot Cloud:
• Click Migration Utility > Export/Import in Automation 360 IQ Bot On-Premises (starting from Build

5931).
Migrazione delle istanze di apprendimento on page 1347

• Eseguire la migrazione dell'istanza di apprendimento in IQ Bot Cloud tramite API. Utilizzare la funzione
Utilità di migrazione per generare i file dell'istanza di apprendimento .iqba, trasferirli tra sistemi e
importarli in nuovi database IQ Bot.
Migrate Learning Instances in IQ Bot Cloud through API (A-People login required)

1. Esportare domini personalizzati da Automation 360 IQ Bot On-Premises a IQ Bot Cloud.
Custom domains in IQ Bot on page 2536
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2. Utilizzare la funzione Utilità di migrazione per esportare le istanze di apprendimento dalla versione
Automation 360 IQ Bot On-Premises.

3. Utilizzare l'interfaccia utente IQ Bot o l'API per caricare il file .iqba su IQ Bot Cloud.
4. Aprire IQ Bot Cloud e importare le istanze di apprendimento utilizzando l'Utilità di migrazione.

Tutte le istanze di apprendimento di Automation 360 IQ Bot On-Premises vengono importate e rese
disponibili su IQ Bot Cloud.

Important:  Rivedi i seguenti punti:
• Se le istanze di apprendimento sono di grandi dimensioni, è necessario eseguirne la migrazione una alla

volta per evitare i timeout.
• Se si utilizzano domini personalizzati, eseguirne la migrazione.
• Importa i domini personalizzati nello stesso ordine in cui si trovavano nella versione Automation 360 IQ

Bot On-Premises.

Migrazione delle istanze di apprendimento
Utilizza la funzionalità Utilità di migrazione di Automation 360 IQ Bot per eseguire la migrazione
(esportazione e importazione) delle istanze di apprendimento tra gli ambienti al fine di evitare di ricreare
istanze di apprendimento simili e gestire facilmente il ciclo di vita dei bots associati.
Le istanze di apprendimento possono essere migrate dall'amministratore di IQ Bot o da un utente associato
a un ruolo personalizzato con autorizzazioni di migrazione. View a list of available learning instances by
using IQ Bot > Administrator > Migration to go to the Migration Utility page.

What is transferred across environments

When you export a learning instance, an IQBA file is created with the following assets:
• Gruppi di documenti
• Training documents (one per document group)
• RPA bots (one per document group)
• Custom domain (contact Automation Anywhere Enterprise support for assistance with transferring this

type of asset)

Note:  Production documents cannot be exported.

Transferring learning instances between IQ Bot environments

To move a learning instance from one environment to another, perform the following steps:
1. Ensure that the source and destination systems are running the same IQ Bot version. Learning

instances from different IQ Bot versions cannot be imported because their database schemas will not
match.

2. Back up your database and export the learning instances from the source IQ Bot environment:
Eseguire il backup e l'esportazione dell'istanza di apprendimento on page 1348

3. Import the IQBA file into the destination IQ Bot environment: Importa istanza di apprendimento on page
1348
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Eseguire il backup e l'esportazione dell'istanza di apprendimento
Assicurati di eseguire il backup dell'istanza di apprendimento esistente prima di esportarla. Un'istanza
di apprendimento viene esportata come file di archivio IQ Bot (IQBA). Con l'istanza di apprendimento
vengono esportati anche i gruppi, i bots e gli apprendimenti associati.
Quando si esporta un'istanza di apprendimento, viene esportato solo un singolo documento associato a
ogni formazione (Gruppo) di bot disponibile. I documenti di produzione, tuttavia, non vengono esportati.

Note:  Assicurati di non esportare un'istanza di apprendimento che ha solo gruppi non classificati.

1. Accedi a IQ Bot come amministratore.
2. Fai clic su Amministrazione > Migrazione.
3. Fai clic su Crea backup.
4. Seleziona le istanze di apprendimento di cui desideri eseguire il backup, quindi fai clic su Backup.
5. Inserisci un nome appropriato per il file IQBA e fai clic su Backup per avviare il processo di

esportazione.
Il file di dati esportato con estensione .iqba è disponibile nella cartella BackupData nella tua
directory di output IQ Bot. Ad esempio C:\Users\Public\Documents\Automation Anywhere
 IQBot Platform\Output\BackupData.

Importa istanza di apprendimento
Import a learning instance to use the associated groups and bots in a different Automation 360 IQ Bot
environment.
Puoi importare un'istanza di apprendimento solo in IQ Bot con versione simile o equivalente. Ad esempio,
puoi importare un'istanza di apprendimento IQ Bot On-Premises (Build 9642) in una versione equivalente
di IQ Bot On-Premises o Cloud.
1. Accedi a IQ Bot come amministratore.
2. Fai clic su Amministrazione > Migrazione.
3. Fai clic su Upload.
4. Seleziona il file .iqba che desideri caricare dal file system.

Exported learning instances are stored as .iqba files. Assicurati di selezionare il file corretto per
importare le istanze di apprendimento nel tuo nuovo ambiente IQ Bot.

5. Select from the following import options:

Import option Risultato

Opzione 1: Append imported groups
and trained bots to duplicate existing
learning instances:

Merges new document groups and bots in
existing learning instances.

Note:  When you import the .iqba file
using this option, a trained group in the
imported file overwrites an untrained group
in the destination environment.
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Import option Risultato

Opzione 2: Import learning instances,
and ignore duplicate learning
instances:

Appends only new learning instances, where
the learning instance ID in the .iqba
file differs from the ID in the destination
environment. If a learning instance ID in
the .iqba file is the same as an ID in
the destination environment, the learning
instance from the file is not appended.

Opzione 3: Overwrite duplicate
existing learning instances with
imported learning instances:

All documents groups and bots in the
existing learning instance in the destination
environment are replaced with the ones
from the imported file. This does not impact
the dashboard metrics.

Note:  You must use this option if the
learning instance in the .iqba file was
edited (for example, if fields or table
columns were added).

Opzione 4: Remove all existing
learning instances and replace with
imported learning instances:

Only use this option if it is okay to lose
all the work done so far in an IQ Bot
environment.

Additional considerations
• If the .iqba file contains a document group that was previously deleted from the learning instance

in the destination environment and you import it using Options 1,3, or 4, IQ Bot restores the
deleted version of that group.

• Document groups in the .iqba file are imported in the same state as they were exported. For
example, if you select Option 3 to overwrite a learning instance with a group in production mode
with an imported learning instance that has a group in staging mode, that imported group remains
in staging mode and incoming documents will not be automatically processed.

For more information on how each option impacts the groups, see Esempio: Import options results on
page 1349.

6. Fai clic su Apri.
Dopo aver caricato il file, fai clic su Aggiorna per aggiornare manualmente la pagina e utilizzare il file
caricato dall'elenco.

7. Click the import icon next to the backup entry in the list.
Le istanze di apprendimento importate vengono ripristinate nell'ambiente di destinazione.

Esempio: Import options results
If the destination IQ Bot environment contains a learning instance with the same ID as the one in the
IQBA file, you must select an import option to instruct IQ Bot how to handle the document groups in the
learning instance. This page walks you through the most-common scenarios.
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Scenario 1: Destination environment is empty
In this scenario, the destination environment is empty, such as in the case of a new installation of a testing
environment. For the simplicity of this example, the IQBA file contains one learning instance with two
groups. The fourth column of the table shows the outcome of each import option.
G = group

Import option Environment before
importing IQBA file

File IQBA Environment after
importing the IQBA file

Opzione 1: Append
imported groups
and trained bots to
duplicate existing
learning instances:

G1, G2

Opzione 2: Import
learning instances,
and ignore duplicate
learning instances:

G1, G2

Opzione 3:
Overwrite duplicate
existing learning
instances with
imported learning
instances:

G1, G2

Opzione 4: Remove
all existing learning
instances and
replace with
imported learning
instances:

G1, G2

G1, G2

Scenario 2: Import a learning instance with new groups
In this scenario, the learning instance in the IQBA file has document groups which are not present in the
learning instance in the destination environment. The fourth column of the table shows the outcome of
each import option, with the groups already present in the environment italicized for emphasis.
Note that in option 3, the imported learning instance (IQBA file) overwrites the duplicate existing learning
instance. To determine whether a learning instance is a duplicate, the system compares the IDs of the
learning instances in the two environments, not the groups. As a result, the environment after the
import only contains G3.

Import option Environment before
importing IQBA file

File IQBA Environment after
importing the IQBA file

Opzione 1: Append
imported groups
and trained bots to
duplicate existing
learning instances:

G1, G2 G3 G1, G2, G3

© 2023 Automation Anywhere. All rights reserved.     1350



    Automation Anywhere - Migrazione a Automation 360

Import option Environment before
importing IQBA file

File IQBA Environment after
importing the IQBA file

Opzione 2: Import
learning instances,
and ignore duplicate
learning instances:

G1, G2

Opzione 3:
Overwrite duplicate
existing learning
instances with
imported learning
instances:

G3

Opzione 4: Remove
all existing learning
instances and
replace with
imported learning
instances:

G3

Scenario 3: Import a learning instance with duplicate groups
In this scenario, the learning instance in the IQBA file has the same groups as the learning instance in
the destination environment, for example, the groups were retrained. The fourth column of the table
shows the outcome of each import option, with the groups already present in the environment italicized for
emphasis.

Import option Environment before
importing IQBA file

File IQBA Environment after
importing the IQBA file

Opzione 1: Append
imported groups
and trained bots to
duplicate existing
learning instances:

G1, G2, G3

Opzione 2: Import
learning instances,
and ignore duplicate
learning instances:

G1, G2, G3

Opzione 3:
Overwrite duplicate
existing learning
instances with
imported learning
instances:

G3

Opzione 4: Remove
all existing learning
instances and
replace with
imported learning
instances:

G1, G2, G3 G3

G3
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Miglioramenti dell'Utilità di migrazione
A partire dalla versione Automation 360 IQ Bot.14, sono stati introdotti miglioramenti per l'importazione
delle istanze di apprendimento (che sono state create utilizzando un dominio personalizzato) nel server di
produzione.
La migrazione delle istanze di apprendimento (che sono state create utilizzando un dominio personalizzato)
da un sistema in un sistema differente non consente di importare automaticamente il dominio associato nel
sistema di destinazione. Pertanto, quando esegui le istanze di apprendimento importate sui documenti di
produzione, i documenti non vengono classificati perché i nomi e gli ID di campo associati per il dominio
personalizzato non funzionano nell'istanza di apprendimento importata

Migrazione di una o più istanze di apprendimento

Prerequisito: Nei server di gestione temporanea (origine) e di produzione (destinazione) deve esistere la
stessa versione del dominio personalizzato.
IQ Bot include alcuni controlli per l'importazione di un'istanza di apprendimento nell'ambiente di produzione
volti ad assicurare che il dominio personalizzato associato a un'istanza di apprendimento venga prima
migrato nel server di produzione, affinché le istanze di apprendimento non restituiscano un errore dopo la
migrazione.
• Puoi importare più volte la stessa istanza di apprendimento nel server di produzione.

Tuttavia, se importi un'istanza di apprendimento con un dominio modificato o aggiornato e il dominio
aggiornato non esiste nel server di produzione, il sistema non consentirà di importare tale l'istanza.

• In this scenario, if the Import option is used (IQ Bot > Migration tab) to import the learning
instance, a system-generated error message is displayed stating that the learning instance version is
incompatible, and the import process is canceled.

• Quando importi un'istanza di apprendimento nel server di produzione di IQ Bot controlla quanto segue:
• Se il dominio esiste nel server di produzione
• Se esistono gli stessi campi nel server di produzione
• Se esistono gli stessi alias di campo (variazioni disponibili per un campo specifico nei documenti) nel

server di produzione

• L'importazione dell'istanza di apprendimento non riesce se il sistema rileva un problema durante uno
qualsiasi dei controlli.

• Un'importazione riesce quando l'utente mantiene la stessa versione dei domini personalizzati, associati
all'istanza di apprendimento nei server di gestione temporanea e di produzione.

Se l'importazione dell'istanza di apprendimento non riesce, l'utente può trovare il motivo dell'errore di
migrazione nelle seguenti posizioni:
• Nei file di registro IQ Bot Project service log, che mostreranno un'incoerenza in uno dei seguenti

parametri:
• Nome del dominio
• Nomi dei campi
• Nome del progetto o dell'istanza di apprendimento
• Nomi alias campo

• In the Control Room > Audit logs

Custom domains in IQ Bot
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Migrating RBAC in IQ Bot
When you migrate learning instances that are associated with custom roles, you must also migrate the
roles to enable users in the destination environment to access the learning instances. Before you start your
migration, review the comparison matrix for in RBAC IQ Bot 11.3.5.x with Automation 360 IQ Bot.

Comparing RBAC

The following table compares RBAC provided in IQ Bot 11.3.5.x with Automation 360 IQ Bot:

Funzionalità Supported in IQ Bot 11.3.5.x Supported in Automation 360
IQ Bot

Separation of permissions
to learning instances by
departments using custom roles

Sì Sì

Assigning roles to learning
instances on creation

Sì Sì

Support for system roles:
• Automation 360 IQ Bot

administrator
• IQ Bot services
• IQ Bot Validator

Sì Sì

Changing assigned role for
learning instances

Sì No

User can have different access
levels to different learning
instances

Sì No

Transfer of roles when learning
instances are moved from one
environment to another

No
However, you can use the
Assign Roles functionality
to assign roles to the learning
instance.

No

All permissions of IQ Bot are
implemented

Sì No
The following permissions are
not implemented:
• Modifica istanza di

apprendimento
• Elimina istanza di

apprendimento
• Invia istanza di

apprendimento in
produzione

• Importa dominio
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Requirements before migrating RBAC

• Ensure that you do not associate the role of a user who can create a learning instance with any of the
IQ Bot system roles. Instead, associate these users with a custom role.

• If a user who can create a learning instance has a custom role, a correct role corresponding to the
department must be assigned to ensure a seamless RBAC operation on the learning instance. However,
ensure that these users do not have any other role assigned other than the custom role for creating a
learning instance and the corresponding department role.

• User who can create a learning instance must not be associated with any non IQ Bot roles. This
restriction is not applicable to other users with custom roles.

• All users who can create a learning instance must not be assigned to one custom role (for creating
learning instance). Instead, these users must be assigned to department-specific custom role (for
creating learning instance).

• Ensure that the View ALL learning instances permission is not used in the custom role because it
provides users with access to IQ Bot services.

• Ensure that any role other than the department role is not assigned to a learning instance, as this can
increase the risk of unauthorized users accessing the learning instance.

• Users with the Launch validator permission in the custom role can only view IQ Bot if there is at least
one learning instance with documents to validate.

Programmazione della migrazione

RBAC functionality such as setup and features for custom roles differ between IQ Bot 11.3.5.x and
Automation 360 IQ Bot. So keep the following in mind for migration:
• You can migrate RBAC to Automation 360 IQ Bot only from IQ Bot 11.3.5 or later versions.
• You can migrate IQ Bot 11.3.5.x to both Automation 360 IQ Bot On-Premises and Cloud.
• When you migrate RBAC, all the custom and user roles are also migrated from Control Room 11.3.5.x to

Automation 360.
• Ensure you segregate the learning instances for RBAC use cases between departments, organization

units, and so on.

Choose your RBAC migration path

Choose your RBAC migration path based on the IQ Bot version you are currently using and the Automation
360 IQ Bot deployment model that meets your business requirements:
• Migrate RBAC to On-Premises
• Migrate RBAC to Cloud

If you are performing the migration steps using APIs, see IQ Bot roles migration APIs (A-People login
required)
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Migrate RBAC to Automation 360 IQ Bot On-Premises
Migrate RBAC from an earlier IQ Bot version (11.3.5.x or later) to Automation 360 IQ Bot On-Premises for
the latest features and enhancements.
1. Create new custom roles (department roles) corresponding to each department or organizational unit

in Control Room.
Consider a scenario where you have setup the RBAC across various departments in your organization
with HR_Dept, Finance_Dept and Sales_Dept as the department roles. For sub-divisions within these
departments, the roles can be Finance_AP_Payments, Finance_Cash_Payments, and so on.

2. Ensure you give the following permissions for each department role that you create:
• View IQ Bot
• View learning Instances
• View learning instances for same role in Control Room

3. Add the respective department roles to all of the IQ Bot users in Control Room.
For example, Sam from the Human Resource department is assigned the HR_Dept role and Susan
from the Finance department is assigned the Finance_Dept role.

4. Associate users who create learning instances with the corresponding roles.
Users creating learning instances for a department can only be associated with IQ Bot roles. For
example, these users cannot be associated with roles such as AA Basic, AA Bot Developer, and so on.
Additionally, only the IQ Bot custom role with Create learning instance permission must be
assigned along with the corresponding department role.

5. Backup the LearningInstanceRoles table in the Automation 360 IQ Bot database.
The database schema name is IQBot.

6. Use the following database query to get the list of learning instances and the roles from the migrated
Automation 360 IQ Bot database:

SELECT p.name as LearningInstance, 
r.projectid as LearningInstanceID, 
r.role as Role FROM [IQBot].[dbo].LearningInstanceRoles r inner join
 [IQBot].[dbo].ProjectDetail p on r.projectid=p.id;

7. Download the output query of the database to a local CSV file.
For example, learninginstanceroles.csv

8. Remove all the role entries against the learning instances in the local CSV file.
For example, learninginstanceroles.csv. After removing the role entries, duplicate rows for
each learning instance must be removed to keep just 1 row per learning instance in the CSV file.

Note:  If there are learning instances which are not RBAC controlled, then role entries must not be
changed

9. Assign the department role (Step 3) to each of the learning instance in the local CSV file and save
your changes.

10. Remove all the entries from the LearningInstanceRoles table in IQBot database scheme.
You can use the following SQL command to remove the entries:
DELETE from [IQBot].[dbo].LearningInstanceRoles;
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11. Insert the modified learning instance role association defined in local CSV file (Step 8) into the
LearningInstanceRoles table.
For example, use the following SQL statement:

INSERT INTO [IQBot].[dbo].LearningInstanceRoles 
(projectid, role) values
 (‘i13454546erty’, ‘HR_Dept’);

12. Verify the RBAC setup in Automation 360 IQ Bot and ensure that only the correct users have the
access to the learning instances.

Migrate RBAC to Automation 360 IQ Bot Cloud
Migrate RBAC from an earlier IQ Bot version (11.3.5.x or later) to Automation 360 IQ Bot Cloud for the
latest features and enhancements.
1. Create new custom roles (department roles) corresponding to each department or organizational unit

in Cloud Control Room.
Consider a scenario where you have setup the RBAC across various departments in your organization
with HR_Dept, Finance_Dept and Sales_Dept as the department roles. For sub-divisions within these
departments, the roles can be Finance_AP_Payments, Finance_Cash_Payments, and so on.

2. Ensure you give the following permissions for each department role that you create:
• View IQ Bot
• View learning Instances
• View learning instances for same role in Control Room

3. Add the respective department roles to all of the IQ Bot users in Control Room.
For example, Sam from the Human Resource department is assigned the HR_Dept role and Susan
from the Finance department is assigned the Finance_Dept role.

4. Associate users who create learning instances with the corresponding roles.
Users creating learning instances for a department can only be associated with IQ Bot roles. For
example, these users cannot be associated with roles such as AA Basic, AA Bot Developer, and so on.
Additionally, only the IQ Bot custom role with Create learning instance permission must be
assigned along with the corresponding department role.

5. Backup the LearningInstanceRoles table in the Automation 360 IQ Bot database.
The database schema name is IQBot.

6. Use the following database query to get the list of learning instances and the roles from the migrated
Automation 360 IQ Bot database:

SELECT p.name as LearningInstance, 
r.projectid as LearningInstanceID, 
r.role as Role FROM [IQBot].[dbo].LearningInstanceRoles r inner join
 [IQBot].[dbo].ProjectDetail p on r.projectid=p.id;

7. Download the output query of the database to a local CSV file.
For example, learninginstanceroles.csv
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8. Remove all the role entries against the learning instances in the local CSV file.
For example, learninginstanceroles.csv. After removing the role entries, duplicate rows for
each learning instance must be removed to keep just 1 row per learning instance in the CSV file.

Note:  If there are learning instances which are not RBAC controlled, then role entries must not be
changed

9. Assign the department role (Step 3) to each of the learning instance in the local CSV file and save
your changes.

10. As the LearningInstanceRoles table in IQBot Cloud will be empty, provide the CSV file (Step 9)
to Automation Anywhere support so that they can update the Cloud database.

11. Insert the modified learning instance role association defined in local CSV file (Step 9) into the
LearningInstanceRoles table.
For example, use the following SQL statement:

INSERT INTO [IQBot].[dbo].LearningInstanceRoles 
(projectid, role) values
 (‘i13454546erty’, ‘HR_Dept’);

Note:  Ensure you perform this step for all the entries in the local CSV file.

12. Verify the RBAC setup in Automation 360 IQ Bot and ensure that only the correct users have the
access to the learning instances.
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Crea
Automation 360 provides a browser-based, intuitive experience for users to easily automate tasks and
powerful tools for developers to build process automation, delivering security, and governance.

Panoramica

Our RPA Workspace is a web-based workspace that provides the tools and capabilities to create, upload,
and deploy bots to automate repetitive tasks and processes. It includes the Control Room, Bot editor, Bot
Runners, Bot Creators, and Credential Vault.
RPA Workspace fornisce le seguenti capacità:
• Automate fast and customize with an actions library for the complicated processes
• Get full visibility and orchestration, from scheduling to automating workloads, with the Control Room
• Assign and manage role-based access with full control and audit trail of every event
• Multi-layered security from cloud to platform to bots ensures granular, privileged access to data.

Crea bots

Use our Bot editor to create and edit bots on any device and from a web browser. Consulta Bot editor for
creating bots alla pagina 1358.
Watch the following videos to get started on building bots:
• Short video on building your first bot:

• Detailed video with a step-by-step guide toward becoming an RPA developer:

For RPA courses, tutorials, certificates and more, visit: Automation Anywhere University: RPA Training and
Certification (A-People login required).
Riferimenti correlati
Actions palette for bot creation alla pagina 1363
Utilizza actions per creare un flusso di lavoro di automazione e per istruire un bot su cosa fare. Le actions
disponibili si trovano nella tavolozza Actions del Bot editor in Control Room.
Variables overview alla pagina 2022
Automation 360 offers a variety of variables, each designed to hold specific types of data and is intended
for specific use. Use the topics below to learn more about each variable and how to use them.
Informazioni correlate
Automation Anywhere Bot Store
Pathfinder Community A-People
Training - Getting Started with RPA

Bot editor for creating bots
Il Bot editor consente agli utenti di creare e modificare bots su qualsiasi dispositivo e da qualsiasi luogo da
cui l'utente possa accedere a un browser Web.
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Panoramica

Because Automation 360 is web-based, there is no separate client to download. Accedi al Bot editor
effettuando l'accesso a Automation 360, navigando sino ad Automazione sul pannello di sinistra e quindi
creando o aprendo un bot.
The Bot editor is a web-based environment and includes the following features:
• Universal Recorder to simplify capturing processes
• Cerca un bot dallo spazio di lavoro pubblico e dal tuo spazio di lavoro privato e aggiungi tale bot al bot

corrente.
Viene visualizzata anche la posizione del bot selezionato negli spazi di lavoro pubblico e privato.

Nota:  Si verifica un errore se nello spazio di lavoro pubblico si aggiunge un bot da una cartella per la
quale non si dispone dell'autorizzazione Clona.

• Powerful bot code management
• Python and JavaScript actions support inline scripting without linking, with drag-and-drop integration
• Rich variable passing, with no cross-language mapping required

Bot editor

Use the Bot editor to create and edit any bot through a web browser, regardless of the device or location.
When you create a bot or modify an existing bot, the Bot editor is displayed.
You can create a bot by using the following options:
• On the Home page, click Create a bot.
• On the Automation page, click Create new > Bot in the top-right corner.
•

In the Files and folders table, click Create a bot ( ).

You can modify a bot by using the following options:
• On the Automation page, select the bot to modify, click the actions menu (vertical ellipses) and click

Edit Task Bot.
• Select and open the bot you want modify.

See also the video at the end of this page on how to get started with the Bot editor.
There are three view options for bot creation:

Nota:  È possibile utilizzare la casella di ricerca nella visualizzazione Flusso, Elenco o Doppia per cercare
testo, variabili o actions in un bot. Questa caratteristica può essere utile quando si visualizza o si modifica
un bot con righe di codice più lunghe.
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• Flusso: Displays actions used in an automation as a flow diagram (Default)

Nota:  The Flow view is not available when you create or edit a bot and the bot exceeds 500 lines of
code. Utilizza l'opzione Mostra vista elenco per passare alla visualizzazione dell'elenco.

• Elenco: Displays the actions used in an automation as a list

Nota:  Trascina l'actions selezionata all'interno della logica dell'attività.
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• Doppio: Displays the actions used in an automation from both Flow and List view aspects

Le visualizzazioni Flusso, Elenco e Doppia visualizzano le seguenti proprietà delle actions:
• Il valore immesso per le actions come Imposta testo per tutte le tecnologie supportate
• I nomi degli oggetti su cui vengono eseguite actions come Imposta testo, Fai clic, Fai clic con il

tasto sinistro, Ottieni proprietà e Seleziona elemento per indice
• Il nome della proprietà dell'oggetto menzionata nell'action
• Il nome della variabile restituita se un valore è assegnato a una variabile
• L'elenco delle proprietà per l'action Ottieni proprietà

See the video on enhanced bot building experience on Bot editor and AISense for Citizen developers.

Bot Assistant

When you create a bot, use the feature Bot Assistant to get a comprehensive view of line numbers of the
bots that require your action.
The Bot Assistant displays the name of the packages or action and line number on which action is required
by you. When you click the line number, it directly takes you to the line where the error occurs.
For migrated bots, the Bot Assistant displays a comprehensive view of the package or action and line
numbers of the bots that require review or action by you.

More resources

• bots Automation 360 gratuiti e pacchetti di comandi da Bot Store: Automation 360 and AARI pre-built
automation

• Create your first bots

Attività correlate
Run a bot alla pagina 1994
You can run a bot to test an automated process.
Riferimenti correlati
Modifica di un bot alla pagina 2007
Edit bot logic using the Bot editor to add, modify, or delete actions and automation steps.
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Keyboard shortcuts to expand or collapse elements in bot logic
When you are creating a large bot, you can expand or collapse sections using keyboard shortcuts in both
Flow and List views.
By using this feature, you can improve your productivity as a Bot Creator. It enables you to use keyboard
shortcuts in a specific section or all sections, and you can move quickly through the process of developing
a bot.
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Shortcuts to expand or collapse an action is applicable only when the section is selected. You can use the
following list of keyboard shortcuts in your bots.

Shortcut Azione

[ Collapses the current node

Ctrl+[ Collapses all the nodes

] Expands the current node

Ctrl+] Expands all the nodes

← Collapses the current node or collapses to parent
if already collapsed

→ Expands the current node

These keyboard shortcuts to expand and collapse nodes are supported in the following packages and
actions:
• Loop package
• If package> If, Else if, and Else actions
• Error handler package> Try, Catch, and Finally actions
• Step package
• Trigger Loop package> Trigger Loop and Handle actions

Actions palette for bot creation
Utilizza actions per creare un flusso di lavoro di automazione e per istruire un bot su cosa fare. Le actions
disponibili si trovano nella tavolozza Actions del Bot editor in Control Room.

Actions, packages, and dependencies

Le Actions sono raggruppate in packages in base alla tecnologia che automatizzano. Ad esempio, il
package Excel advanced contiene actions correlate a Excel, ad esempio Apri cartella di lavoro, Vai alla
cella ed Elimina cella, che puoi inserire in Bot editor per automatizzare un processo di foglio di calcolo.
Ciascun package è aggiornato e abilitato singolarmente per supportare nuove funzionalità. I nuovi bots
sono realizzati con la versione predefinita. I bots esistenti non vengono aggiornati automaticamente.
Vengono eseguiti utilizzando la stessa versione del package con cui sono stati creati fino a quando il Bot
Creator non esegue manualmente gli aggiornamenti alla nuova versione.
Quando Control Room distribuisce un bot, i packages utilizzati per creare l'automazione vengono raccolti e
inviati al Bot Agent sul dispositivo di destinazione. Il Bot Agent memorizza nella cache i packages in modo
che non siano richiesti aggiornamenti ogni volta che il bot viene eseguito.
Per ridurre il runtime la prima volta che un bot viene eseguito su dispositivo, precarica i packages
utilizzando l'opzione Precarica i pacchetti in Bot editor. Il sistema carica i packages in \ProgramData
\AutomationAnywhere\GlobalCache sul computer locale per un rapido accesso in fase di runtime.
After an action from a package is used in a bot, that package becomes a dependent file of that bot.
• Learn more about managing packages in Pacchetti alla pagina 2640.
• Developers can learn more about creating packages in Pacchetto SDK alla pagina 2364.
• Learn more about managing bots and package dependencies in Bot dependencies alla pagina 2046.
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Packages and exe files

Packages exe process files

DLL Automation.CSharpDLLWrapper.exe

Database Automation.DatabasePlayer.exe

Working with actions

Importante:  Ciascuna action di un package fornisce informazioni minime sulla compatibilità della Control
Room e sulla versione del Bot Agent quando si creano i bots. In questo modo è possibile aggiornare i bots
e ridurre gli errori di runtime causati da una versione di Control Room o Bot Agent incompatibile.

Puoi configurare le actions in Bot editor. Fai doppio clic su action per visualizzare i campi e le funzioni che è
possibile configurare e fai doppio clic o trascina una action per inserirla nell'automazione.
Passa il mouse sui puntini di sospensione verticali in alto a destra di un'icona action per accedere alle
seguenti funzioni:

Copia action Duplicate the action.
Cut action Copy the action and remove it from the bot code.
Paste after action Paste the copied action below the selected action.

Nota:  This option only appears when there is an
action in the clipboard.

Elimina action Remove the action from the bot code.
Disable action At run time, bot ignores the action until you enable

it.
Abilita punto di interruzione Pauses the bot for debugging purposes.

Debugger tool alla pagina 2463
Vai oltre Use the Step over icon to go to the next action

in debug mode. By default, it starts from the first
action in debug mode.

You can edit multiple actions at a time, using the toolbar at the top of the Bot editor.

Trova in questo bot (casella di ricerca) Cerca qualsiasi testo o action come il nome di un
package, nomi di actions, nome di stringa o nome
di variabile nella vista Flusso, Elenco o Doppio del
TaskBot. È possibile cercare il testo in più pagine
del bot e non è necessario caricare manualmente le
pagine. Questa funzionalità consente di visualizzare
o modificare un bot con lunghe righe di codice per
determinare dove e in quale riga viene utilizzato
il testo cercato, ad esempio variabili, stringhe o
actions.
• Puoi cercare solo all'interno delle righe di codice

nel Bot editor.
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• La ricerca non fa distinzione tra maiuscole e
minuscole.

Copia elementi Copy actions to a clipboard so they can be
duplicated within the bot.

Taglia elementi Copy the actions and remove them from the bot
code.

Incolla elementi Paste one or more actions after the highlighted
action. If you have not highlighted an action, the
actions are appended to the end of the automation
sequence.

Nota:  This icon is only enabled when there are
actions in the clipboard.

Copia negli appunti condivisi Copy actions, triggers, and metadata to a clipboard
that is shared between bots.

Incolla dagli appunti condivisi Paste actions, triggers, and metadata from another
bot.

Nota:  This icon is only enabled when there are
actions in the shared clipboard.

Funzionalità di salvataggio automatico degli eventi in Bot editor

In Bot editor, quando si utilizzano actions per creare un'automazione, quando un bot non viene salvato
manualmente, viene eseguito un salvataggio automatico e il bot salva ora automaticamente le modifiche
per eventi specifici.

Nota:  La funzionalità di salvataggio automatico è attualmente disponibile solo per eventi specifici.

Alcuni degli eventi che supportano la funzionalità di salvataggio automatico sono i seguenti:
• Registratore: Quando si crea un bot con determinate actions e si fa clic su Registratore, l'evento viene

salvato e al termine della registrazione l'evento viene salvato in modo automatico.
• Gestione variabili: Quando si crea o si modifica una variabile per inserirla in un'action, le modifiche

vengono salvate.

Nota:  La funzionalità di salvataggio automatico non è supportata quando si elimina una variabile o la
si inserisce premendo F2 per aprire l'elenco delle variabili.

• Menu Azioni (puntini di sospensione verticali): Quando si seleziona una qualsiasi action da questo
menu, per esempio Pacchetti, l'evento viene salvato automaticamente. Quando si applica una qualsiasi
modifica alla pagina Pacchetti e si ritorna al Bot editor, l'evento viene salvato.

• Trova un file: Quando fai clic sull'icona Trova un file, il bot viene salvato se non è stato salvato
manualmente. Inoltre, dopo aver fatto clic sull'opzione Aggiungi, il bot viene automaticamente salvato.

• Finestre di dialogo: Quando una finestra di dialogo viene aperta, questa viene automaticamente salvata
se vengono fatte delle modifiche.

Nota:  Il salvataggio automatico viene attivato solo per le finestre di dialogo di primo livello e non per
quelle annidate.

• Eliminazione di variabili: Quando si eliminano variabili inutilizzate, l'evento viene salvato.
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• Modifica del nome di un Bot: Se si modifica il nome di un bot, l'evento viene salvato.

Risorse

Riferimenti correlati
Bot editor for creating bots alla pagina 1358
Il Bot editor consente agli utenti di creare e modificare bots su qualsiasi dispositivo e da qualsiasi luogo da
cui l'utente possa accedere a un browser Web.

Advanced search option in Bot editor
When you edit or view a bot, you can use the advanced search feature to find the exact line of action and
the corresponding details where the search text appears, select the search filter criteria, and navigate
through the search results.
Search for any text value or variable name within action details across a bot by using the Advanced
search feature. You can access Advanced search from the Bot editor in one of the following ways:
• Click the Assistant icon at the top.
• Click Search in this bot > Open advanced search icon.
• Use Ctrl + Shift + F shortcut keys.

If you enter a search term in the Search in this bot field and then click the Open advanced search
icon, the search term is carried over and displayed on the Advanced search page.
The Advanced search feature comprises of three components:

Ricerca

In the Advanced search page, you can enter a search text in the search box. You can search for a text
value, variable name, or long text that has multiple matches.
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Figura 2: Ricerca

You can also select the search filter criteria and navigate through the search results.

Nota:  Advanced search is not case sensitive.

Search filters

You can use filters to narrow down the search results and quickly locate the search text. The filters can
include the following search criteria:
• Canvas (Flow and List views): to search for any text within the canvas that is displayed in the flow and

list views.
• Text value: to search for any text value within the action details.
• Variable name: to search for any variable name within the action details.

You can select or clear one or all the filter check boxes depending on the search criteria.
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Figura 3: Search filter

When you click a matching item from the action details, for example, if you select the second search result
If| Line 6 | 2 matches in the Results tab, you will see the complete line of action that contains the
search text highlighted in the canvas, and the details of the selected action are displayed on the properties
panel. You can see that the searched text botname is appearing in the if condition, as shown in the
properties panel.

Risultati

When you enter the search text and select the filter criteria, the Advanced search page displays the
search results based on action names across the different lines of the bot.
The Results header displays the total count of matched action names and the count of selected action
or line item in a bot. For each action name listed, the line number containing the action and the total
matching results found within the action details are displayed as Action or Trigger | Line number |
Number of matches.

Nota:  The count displayed in the Results header displays only the count of matching line items (or
actions) within the bot. However, each line item can have multiple matches and is not counted in the
total matching line items. For individual line items, the count of multiple matches is displayed within the
particular line item in the Results tab.

When you select a specific line item against the action name, the action detail page opens within Results
tab displaying a list of all matching results within that action.
When there is more than one search result, you can use the Back button to go to the previous line
and the Next button to go to the next item. When you select the Back or Next button, the action is
highlighted in the canvas, and the detail of the corresponding item is displayed in the properties panel.
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The following example shows how Advanced search works. You are editing a bot with lengthy lines of
code. Now you want to search with the text botname in the Assistant window. The Results header
shows the total count of 10 matched action names and line numbers with the count of matching line items,
such as If| Line 6 | 2 matches.

Figura 4: Risultati

AARI Web package
The AARI on the web  package contains actions that enable Control Room users to configure their bots
to work on requests, tasks, and team members.

Prima di iniziare

Assicurati di aver soddisfatto una delle seguenti condizioni per eseguire questo package:

Condizione 1 • Accesso a un processo in un team assegnato.
• Accesso a una licenza utente AARI.
• Ruolo Utente AAE_Robotic_Interface creato

dal sistema per l'utente AARI.

Condizione 2 • Accesso a una licenza Bot Runner (con o senza
operatore) o una licenza Bot Creator.

• Ruolo creato dall'utente con le autorizzazioni
Visualizza i miei bot ed Esegui i miei bot.
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Actions in the AARI on the web package

The AARI on the web  package includes the following actions:

Action Descrizione

Assegna attività Consente di assegnare opzioni a un'attività.
• Nel campo ID attività da assegnare, specifica un valore.
• Nel campo ID utente da assegnare all'attività, specifica un valore.

Per l'ID attività e utente, è possibile selezionare un valore dalle
opzioni Variabile o Valore globale. L'opzione variabile permette di
aggiungere variabili predefinite che vanno dal tempo (minuto, ora,
giorno, mese, anno, ecc.) all'utilizzo del sistema (CPU e RAM).

• Facoltativo: Nel campo Assegna il risultato alla variabile, assegna
una variabile da memorizzare come output.
L'output viene memorizzato come valore stringa.

Annulla attività Consente di annullare un'attività.
• Nel campo ID attività da annullare, specifica un valore.

Per l'attività, è possibile selezionare un valore dalle opzioni Variabile
o Valore globale. L'opzione variabile permette di aggiungere variabili
predefinite che vanno dal tempo (minuto, ora, giorno, mese, anno,
ecc.) all'utilizzo del sistema (CPU e RAM).

• Facoltativo: Nel campo Assegna il risultato alla variabile, assegna
una variabile da memorizzare come output.
L'output viene memorizzato come valore stringa.
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Action Descrizione

Crea una richiesta Consente di creare una richiesta.
• Nella tavolozza Azioni fai doppio clic o trascina l'azione Crea una

richiesta dal pacchetto AARI Web.
• Nel campo Processo pubblico, sfoglia e seleziona il processo

pubblico. I campi modulo iniziali del processo sono visualizzati nel
campo Valori di input. Questi campi provengono da elementi di forma
interattivi supportati.

• Nel campo Valori di input inserire i valori o le variabili per completare
le informazioni richieste nel modulo iniziale.

Nota:  Per passare i valori attraverso le variabili, crea una variabile
personalizzata di qualsiasi tipo: Stringa, Numero, Data e ora,
Operatore booleano, Dizionario, Tabella o File. Utilizza la variabile
Dizionario per completare le informazioni delle caselle di controllo nel
modulo iniziale. Immetti le informazioni sulla variabile nei campi Tipo,
Sottotipo, Chiave e Valore. Nel campo Sottotipo scegli Operatore
booleano. Segui la convenzione di formato durante la creazione delle
variabili Dizionario.
Ad esempio, consideriamo gli attributi delle caselle di controllo San
Jose, Atlanta e Sacramento e selezioniamo il valore Atlanta nel campo
modulo iniziale. Crea una variabile Dizionario del sottotipo Operatore
booleano nel formato seguente:
Nome: CheckBoxGroup0

Attributi () Chiave Valore

San Jose CheckBoxGroup0_0 falso

Atlanta CheckBoxGroup0_1 vero

Sacramento CheckBoxGroup0_2 falso

• Facoltativo: Nel campo Assegna ID richiesta a, assegna una
variabile da memorizzare come output. Restituisce l'ID della richiesta
creata.

• Facoltativo: Nel campo Assegna riferimento richiesta a, assegna
una variabile da memorizzare come output. Restituisce l'ID della
richiesta creata.

• Fai clic su Salva.
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Action Descrizione

Ottieni file di
archiviazione

Scarica il file di archiviazione su un dispositivo bot.

Importante:  L'action Ottieni file di archiviazione richiede la
corrispondenza delle versioni tra la versione del processo e la versione del
package. I processi creati prima di Automation 360 v.25 devono essere
utilizzati con versioni del package precedenti alla Automation 360 v.25.
Allo stesso modo, i processi creati dopo la versione Automation 360 v.25
devono essere utilizzati con package di versioni successive alla Automation
360 v.25.

• Specifica l'URI del file di archiviazione nel campo Variabile.
Immetti la tua variabile di input del file.

Importante:  Devi utilizzare solo l'opzione Variabile e la variabile
deve essere un input di file che viene popolato dal processo
(Seleziona file in Attività umana). Non utilizzare le opzioni File
Control Room e File desktop.

• In Percorso completo del file da salvare sul dispositivo locale,
specifica il percorso per memorizzare il file.
È possibile scegliere tra le opzioni Variabile e Valore globale.
L'opzione variabile permette di aggiungere un valore definito
dall'utente, appunti, stringa (invio, nuova riga, separa, ecc.), sistema
(nome attività, URL control room, ecc.), pacchetto di variabili
predefinite (data, minuto, giorno, ora, indirizzo IP, sistema operativo,
ecc.) o valore analitico tabella.

• Facoltativo Nel campo Risultato, scegli una variabile.
L'output è memorizzato come variabile.
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Action Descrizione

Richieste di query Consente all'utente di eseguire richieste di query con filtri personalizzati.
• Seleziona un filtro.

Nota:  I filtri per titoli di processo e richiesta, tag, ID, nome team e tag
PII hanno lo stesso elenco di opzioni.

• Specifica il valore stringa nel campo Elenco o Variabile.
• Specifica il tipo nel campo Elenco o Variabile.
• Elenco: Immetti le informazioni sul valore nei campi Tipo e Valore

a 0.
• Facoltativo: Nel campo Aggiungi, aggiungi altri valori.
• Variabile: Inserisci la variabile personalizzata.

• Nel campo Stato richiesta, seleziona uno stato.
È possibile scegliere APERTO, OPERAZIONE RIUSCITA, ERRORE e
OPERAZIONE ANNULLATA

• Nel campo Pagina, specifica un valore.
• Nel campo Inizio tabella all'offset dei dati, inserisci un valore.
• Nel campo Numero di righe per pagina, inserisci un valore.

Il valore predefinito per il numero di righe è impostato su 200.

• Nel campo Ordina, specifica l'opzione.
• Nel campo Direzione, seleziona Decrescente o Crescente.

Il valore predefinito per la direzione è impostato su Decrescente.
• Nel campo Seleziona colonna da ordinare, seleziona un'opzione.

Puoi scegliere tra il titolo del processo o la creazione della richiesta,
l'ID, il titolo, lo stato o il tag PII.

• Seleziona Abilita ordinamento 2° grado e specifica i campi
Direzione e Seleziona colonna da ordinare.

• Nel campo Assegna il risultato alla variabile, assegna una variabile
da memorizzare come output.
L'output viene memorizzato come valore tabella.
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Action Descrizione

Attività query Consente a un utente di eseguire attività query con filtri personalizzati.
• Seleziona un filtro.

Nota:  Il filtro per titoli di processo e richiesta, tag, ID, stato, nome
team e tag PII ha lo stesso elenco di opzioni.

• Specifica il valore stringa nel campo Elenco o Variabile.
• Specifica il tipo nel campo Elenco o Variabile.
• Elenco: Immetti le informazioni sul valore nei campi Tipo e Valore

a 0.
• Facoltativo: Nel campo Aggiungi, aggiungi altri valori.
• Variabile: Inserisci la variabile personalizzata.

• Nel campo Stato richiesta, seleziona uno stato.
È possibile scegliere APERTO, OPERAZIONE RIUSCITA, ERRORE e
OPERAZIONE ANNULLATA

• Nel campo Stato attività, seleziona uno stato.
È possibile scegliere IN_PROGRESS e COMPLETED.

• Nel campo Pagina, specifica un valore.
• Nel campo Inizio tabella all'offset dei dati, inserisci un valore.
• Nel campo Numero di righe per pagina, aggiorna il valore.

Il valore predefinito per il numero di righe è impostato su 200.

• Nel campo Ordina, specifica le seguenti opzioni.
• Nel campo Direzione, seleziona Decrescente o Crescente.

Il valore predefinito per la direzione è Decrescente.
• Nel campo Seleziona colonna da ordinare, seleziona un'opzione.

Puoi scegliere tra ID richiesta e attività, titoli, creazione, stato o tag
PII.
Puoi scegliere tra ID riferimento richiesta e attività, titoli, creazione,
stato o tag PII.

• Seleziona Abilita ordinamento 2° grado e specifica i campi
Direzione e Seleziona colonna da ordinare.

• Nel campo Assegna il risultato alla variabile, assegna una variabile
da memorizzare come output.
L'output viene memorizzato come valore tabella.
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Action Descrizione

Membri del team Recupera l'elenco dei membri di un team.
• Nel campo Fornisci ID team per effettuare query sui suoi

membri, specifica un valore.
Per l'ID del team, è possibile selezionare un valore dalle opzioni
Variabile o Valore globale. L'opzione variabile permette di
aggiungere variabili predefinite che vanno dal tempo (minuto, ora,
giorno, mese, anno, ecc.) all'utilizzo del sistema (CPU e RAM).

• Nel campo Fornisci riferimento team per effettuare query sui
suoi membri, specifica un valore.
Per il riferimento del team, puoi selezionare un valore dalle opzioni
Variabile o Valore globale. Con l'opzione variabile puoi aggiungere
variabili predefinite che vanno dal tempo (minuto, ora, giorno, mese,
anno, e così via) all'utilizzo del sistema (CPU e RAM).

• Nel campo Assegna il risultato alla variabile, assegna una variabile
da memorizzare come output.
L'output viene memorizzato come valore tabella.

Example of using Create a Request action
The Create a Request action from the AARI Web package enables you to create a new request in AARI
on the web through a bot. In this example, use the Create a Request action to pass data through bot
variables to initial form of the AARI process.
• You must have a Bot Creator license and be assigned a custom role with the following permissions:

• Check-in and check-out permission
• Create folder permission

• Create a process and check-in the process to the public workspace
• Assign at least one team to the process with the default team selected
• Select the by bot option in the Request creation field

In this example, we will create a process to register new employee details in the company database. The
initial form contains basic information such as Name, ID, Date of Birth, Gender, and Location. We will pass
the initial form data through bot variables.
1. Log in to the Control Room as a Bot Creator user.
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2. Create the initial form.
Create an AARI form alla pagina 2123.
a) On the left plane, click Automation.
b) Click Create new > Form.
c) Enter the form name employee_register_initial_form.
d) Enter the folder location Bots\Employee Registration.

To change where your form is stored, click Choose and follow the prompts.
e) Fai clic su Crea e modifica.
f) Use the following Elements and Element label in the form.

Elementi Etichetta elemento

TextBox Full Name

Numero ID

Data Date of Joining

Elenco a discesa Gender

Checkbox Location

Select File Resume

• For the Dropdown element, enter Male, Female in the Enter list items separated by
commas field.

• For the Checkbox element, click the plus icon in Checkbox content field and add the
locations San Jose, Tokyo, India.

• For the Select File element, you can limit the file type which can be uploaded by specifying
it in the Enter supported file format separated by commas field. For example; doc, gif,
pdf, png, txt, xls.

g) Fai clic su Salva.
h) Fai clic su Chiudi.

3. Create a new process.
a) In the same folder location, click Create new > Process.

Crea un processo AARI alla pagina 2133.
b) Enter the process name employee_register.
c) Fai clic su Crea e modifica.
d) Click Start to add an initial form to the process.
e) In the Select initial data form field, browse and select the initial form,

employee_register_initial_form.
f) Select AARI Storage in the File upload storage dropdown.
g) Provide Request title as Employee Registration.
h) Fai clic su Salva.
i) Fai clic su Chiudi.
j) Check in this process to the public workspace.
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4. Create a new bot.
a) In the same folder location, click Create new > Bot.
b) Enter the bot name employee_register_request_bot.
c) Fai clic su Crea e modifica.

5. Create the following variables:
• emp_name: String type; use as input.
• emp_id: Number type; use as input.
• emp_date_of_joining: Datetime type; use as input.
• emp_gender: String type; use as input.
• emp_location: Dictionary type, Boolean subtype; use as input. From the check box attributes given

above, if you want to select the value San Jose for the location attribute in the initial form field,
click the plus and create the dictionary variable in the format as given below:
Name: emp_location

Attributi () Chiave Valore

San Jose CheckBoxGroup0_0 True

Tokyo CheckBoxGroup0_1 False

India CheckBoxGroup0_2 False

• emp_resume: File type; use as input, select Desktop folder or file for the Default value and
browse and select the file you want to upload.

• employee_registration_request_id: Number type; use as output.

6. Use the Create a Request action from AARI Web package.
a) Nella tavolozza Azioni fai doppio clic o trascina l'azione Crea una richiesta dal pacchetto AARI

Web.
b) In the Public Process field, browse and select the public process employee_register. I

campi modulo iniziali del processo sono visualizzati nel campo Valori di input. Questi campi
provengono da elementi di forma interattivi supportati.

c) In the Input values field, enter the values or variables to complete the required information to
the initial form as given below:
• emp_name: $emp_name$
• emp_id: $emp_id$
• emp_date_of_joining: $emp_date_of_joining$
• emp_gender: $emp_genders$
• emp_location: $emp_location$. To select the location San Jose in the initial form field, add

the key and value pair for the attributes as given below:

Attributi () Chiave Valore

San Jose CheckBoxGroup0_0 True

Tokyo CheckBoxGroup0_1 False
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Attributi () Chiave Valore

India CheckBoxGroup0_2 False

• emp_resume: $emp_resume$
• employee_registration_request_id: $employee_registration_request_id$

d) Fai clic su Salva.
e) Fai clic su Chiudi.

7. Deploy the bot.
a) Fai clic su Esegui.
b) In the Set input variables field, enter the values for the input variable.
c) Fai clic su Conferma.

The bot deploys successfully and a new request is created through the default team assigned to the
process. The initial form fields are filled with the input provided through the bot. In the web interface,
an AARI admin can verify that a new request is created, and the data has been selected properly.

Active Directory package
Use the Active Directory package to automate actions in the Active Directory. An Active Directory
is a directory service provided by Microsoft to assist the admin in managing users across a group or
organization.
RPA Workspace uses Lightweight Directory Access Protocol (LDAP) to read from and edit users in the
Active Directory. The server and domain names are combined to create an LDAP path, which is used to
connect to the Active Directory.

Prima di iniziare

Esegui le seguenti actions contenute nel package Active Directory come parte integrante dell'utilizzo del
set di actions disponibili:
1. Establish a connection with the Active Directory using the Connect action. Utilizza questo stesso

nome di sessione per le altre actions. Using Connect action for Active Directory alla pagina 1383
2. Utilizza le actions per automatizzare un'attività.
3. After you have automated all the Active Directory-related tasks, terminate the connection to the server

using the Disconnect action.

Operations in the Active Directory package

The Active Directory package includes the following operations:

Operazione Descrizione

Computer operations Consulta Computer operations alla pagina 1379.

Group operations Consulta Group operations alla pagina 1381.

LDAP operazioni Consulta LDAP operazioni alla pagina 1382.
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Operazione Descrizione

Organizational unit
operations

Consulta Organizational unit operations alla pagina 1384.

User account
operations

Consulta User account operations alla pagina 1386.

Computer operations
The computer operations in the Active Directory package contain various actions to automate tasks related
to computers, including create, delete, get property, rename, and set property.

Actions nel package Active Directory

The Active Directory package includes the following actions for computer operations:

Action Descrizione

Crea computer Vedi Create computer action in Active Directory alla pagina 1379

Elimina computer Vedi Delete computer action in Active Directory alla pagina 1379

Ottieni proprietà del
computer

Vedi Get computer property action in Active Directory alla pagina 1380

Sposta computer Vedi Using the Move computer action alla pagina 1380

Rinomina computer Vedi Rename computer action in Active Directory alla pagina 1380

Imposta proprietà del
computer

Vedi Set computer property action in Active Directory alla pagina 1381

Create computer action in Active Directory
The Create computer action in the Active Directory package enables you to create a new object for the
computer.

Impostazioni

• Enter the same session name as the one you used in the Connect action.
• Enter a name for the computer.
• Facoltativo: Enter a description of the computer.

Delete computer action in Active Directory
The Delete computer action in the Active Directory package enables you to delete an existing computer.

Impostazioni

• .Enter the same session name as the one you used in the Connect .
• Enter a name for the computer.
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Get computer property action in Active Directory
The Get computer action in the Active Directory package enables you to retrieve a specific property value
for a computer.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Enter the computer name.
• Enter the property.
• Assign the value to a string variable.

Using the Move computer action
Use the Move computer action to move the computer from an existing location to a new location.
Ensure there is an existing computer.
Computer operations alla pagina 1379
1. In the Actions palette, double-click or drag the Move computer action from the Active Directory

package.
2. Add the computer name:

• Select the name from the server:
a. Click Add computer from server.
b. Enter the host and domain credentials in the Connect to server window and click Connect.
c. In the Select computer window, select the computer name from the Domain Objects panel

and click Apply.

• Enter the name in the Computer name field.

3. Add the LDAP path: or perform the following steps if you choose the option :
• Enter the path in the Move to field.
• Click Select computer object and perform these steps:

a. Enter the host and domain credentials in the Connect to server window and click Connect.
b. In the Select computer window, select the destination server path from the Domain

Objects panel and click Apply.

4. Enter the same session name in the Active Directory session that you used in the Connect action.
5. Click Save and Apply.

Rename computer action in Active Directory
The Rename computer action in the Active Directory package enables you to rename an existing
computer.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Enter a name for the computer.
• Enter a new name for the computer.
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Set computer property action in Active Directory
The Set computer property action in the Active Directory package enables you to assign a value to a
computer property.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Enter the computer name.
• Enter the property to update.
• Enter the new value.

Group operations
The group operations in the Active Directory package contain various actions to automate tasks related to
groups, including create, delete, get property, and set property.

Actions nel package Active Directory

The Active Directory package includes the following actions for group operations:

Action Descrizione

Crea gruppo Vedi Create group action in Active Directory alla pagina 1381

Elimina gruppo Vedi Delete group action in Active Directory alla pagina 1382

Ottieni proprietà di un
gruppo

Vedi Get group property action in Active Directory alla pagina 1382

Rinomina gruppo Vedi Rename group action in Active Directory alla pagina 1382

Imposta proprietà del
gruppo

Vedi Set group property action in Active Directory alla pagina 1382

Create group action in Active Directory
The Create group action in the Active Directory package enables you to create a new group.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Enter a unique name for the group.
• Facoltativo: Enter a description for the group.
• Select the group scope from the following options:

• Domain Local
• Global
• Universal

Group scope
• Select the group type from the following options:

• Security: Provides users with access rights to folders.
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• Distribution: Sends emails to a group of users.

Delete group action in Active Directory
The Delete group action in the Active Directory package enables you to delete an existing group.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Enter the name of the group to delete.

Get group property action in Active Directory
The Get group property action in the Active Directory package enables you to retrieve a specific
property value for the group.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Enter the group name.
• Enter the property.
• Assign the value to a string variable.

Rename group action in Active Directory
The Rename group action in the Active Directory package enables you to rename an existing group.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Enter the group name.
• Enter a new name for the group.

Set group property action in Active Directory
The Set group property action in the Active Directory package enables you to assign a value to a group
property.

Impostazioni

Assigns a value to a group property.
• Enter the same session name as the one you used in the Connect .
• Enter the group name.
• Enter the property to update.
• Enter the new value.

LDAP operazioni
The Lightweight Directory Access Protocol (LDAP) operations in the Active Directory package contain
various actions to automate tasks related to LDAP, including connect, disconnect, and run query.
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Actions nel package Active Directory

The Active Directory package includes the following actions for LDAP operations:

Action Descrizione

Connetti Vedi Using Connect action for Active Directory alla pagina 1383

Disconnetti Closes the connection with the LDAP server.

Esegui query Vedi Run query action in Active Directory alla pagina 1384

Using Connect action for Active Directory
Use the Connect action to establish a connection with an Active Directory server. This is the first action
you must use to automate an Active Directory related task.
This action enables you to provide the server credentials and details, and associate this information with
a session name. Use this same session name for the other Active Directory actions so that you have to
provide the server information only once.
To establish a connection with an Active Directory server, follow these steps:
1. Nella tavolozza Actions, fai doppio clic o trascina l'action Connetti dal package Active Directory.
2. Inserisci un nome della sessione.
3. Enter or create the LDAP URL:

• Parent path: Enter the LDAP URL that identifies the server that hosts the Active Directory
services.
For example, LDAP://192.168.2.60/DC=corporate,DC=com

• Build parent path: Create the LDAP URL:
a. Click the Build parent path option to connect to the Active Directory server.
b. In the Connect to server window, enter the host and domain credentials, and click

Connect.
c. In the Object Explorer window, select the specific path from the Objects panel.
d. Verify the selected LDAP URL path in the Preview field and click Apply.

4. In the Login user field, provide your username with one of the following options:
• Credenziale: Select a credential from the Credential Vault. Credentials and credential variables in the

Bot editor alla pagina 2039
• Variabile: Select a variable holding a credential data type value. Le tue variabili (definite dall'utente)

alla pagina 2026
• Insecure string: Enter a value or select a variable.

Importante:  Values entered using this option are not encrypted.
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5. In the Login password field, provide your password with one of the following options:
• Credenziale: Select a credential from the Credential Vault. Credentials and credential variables in the

Bot editor alla pagina 2039
• Variabile: Select a variable holding a credential data type value. Le tue variabili (definite dall'utente)

alla pagina 2026
• Insecure string: Enter a value or select a variable.

Importante:  Values entered using this option are not encrypted.

6. Fai clic su Salva.
7. After you have automated all the Active Directory-related tasks, terminate the connection to the server

using the Disconnect action.

Run query action in Active Directory
The Run query action in the Active Directory package enables you to run a specified Active Directory
query. The query results are stored in a list variable, either for object names or LDAP paths, depending on
the option selected.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Input the query. Ad esempio: (&(objectCategory=person)(objectClass=user)(name=A*))
• Specify the return type. Select either the Object Name or LDAP Path option.
• Assign the value to a string variable.

Organizational unit operations
The organizational unit operations in the Active Directory package contain various actions to automate
tasks related to organizational units, including create, delete, and rename organizational units, and get and
set property.

Actions nel package Active Directory

The Active Directory package includes the following actions for organizational unit operations:

Action Descrizione

Crea unità
organizzativa

Vedi Create organizational unit action in Active Directory alla pagina 1385

Elimina unità
organizzativa

Vedi Delete organizational unit action in Active Directory alla pagina 1385

Ottieni proprietà unità
organizzativa

Vedi Get organizational unit property action in Active Directory alla pagina
1385

Sposta unità
organizzativa

Vedi Using the Move organizational unit action alla pagina 1385

Rinomina unità
organizzativa

Vedi Rename organizational unit action in Active Directory alla pagina 1386
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Action Descrizione

Imposta proprietà
unità organizzativa

Vedi Set organizational unit property action in Active Directory alla pagina
1386

Create organizational unit action in Active Directory
The Create organizational unit action in the Active Directory package enables you to create a new
object for the organizational unit.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Enter a name for the organizational unit.
• Facoltativo: Enter a description of the organizational unit.

Delete organizational unit action in Active Directory
The Delete organizational unit action in the Active Directory package enables you to delete an existing
organizational unit.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Enter the name of the organizational unit to delete.

Get organizational unit property action in Active Directory
The Get organizational unit property action in the Active Directory package enables you to retrieve a
specific property value for an organization and assigns the results to a variable.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Enter the organizational unit name.
• Enter the property.
• Assign the retrieved value to a string variable.

Using the Move organizational unit action
Use the Move organizational unit action to move an organizational unit from an existing location to a new
location.
Ensure there is an existing organizational unit.
Organizational unit operations alla pagina 1384
1. In the Actions palette, double-click or drag the Move organizational unit action from the Active

Directory package.
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2. Add the organizational unit name:
• Add the name from the server by performing these steps:

a. Click Add organizational units from server.
b. Enter the host and domain credentials in the Connect to server window and click Connect.
c. In the Select organizational unit window, select the organizational unit name from the

Domain Objects panel and click Apply.

• Enter the name in the Organizational unit name field.

3. Add the LDAP path: or perform the following steps if you choose the option Select organizational
unit object
• Enter the path in the Move to field.
• Select organizational unit object and perform these steps:

a. Enter the host and domain credentials in the Connect to server window and click Connect.
b. In the Select organizational unit window, select the destination server path from the

Domain Objects panel and click Apply.

4. Enter the same session name in the Active Directory session that you used in the Connect action.
5. Click Save and Apply.

Rename organizational unit action in Active Directory
The Rename organizational unit action in the Active Directory package enables you to rename an
existing organizational unit.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Enter the name of the organizational unit to rename.
• Enter the new name.

Set organizational unit property action in Active Directory
The Set organizational unit property action in the Active Directory package enables you to assign a
value to an organizational property.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Enter the organizational unit name.
• Enter the property to update.
• Enter the new value.

User account operations
The Active Directory package contains various actions to automate tasks related to user account
management, including create, delete, get property, remove, rename, and set property.
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Actions nel package Active Directory

The Active Directory package includes the following actions for user account operations:

Nota:  We now support Active Directory user operations by logon name with domain and can provide the
domain name to extract the user details. When you retrieve user property or perform any user operation
based on the logon name (userPrincipalName), and if the user domain name differs from the domain
specified in the LDAP path, the user properties are now successfully retrieved regardless of whether it
contains a domain name or not.
For example, LDAP Path: LDAP://ADServer/DC=automation, DC=net

User Logon name

userPrincipalName: kim@aaengg.net User can provide logon name as
kim@aaengg.net.

userPrincipalName: shaun@aasales.net User can provide logon name as
shaun@aasales.net.

userPrincipalName:sarah@automation.net user can provide a logon name as either sarah
or sarah@automation.net.

When you perform any user action on the logon name, and if the logon name has a duplicate user under
subDomain and subDomain@rootDomain, the user property is retrieved for the user with the root domain.
For example, LDAP Path: LDAP://ADServer/DC=automation, DC=net
• User 1: userPrincipalName (logon name) is kim@aaengg.net.
• User 2: userPrincipalName (logon name) is kim@aaengg.net@automation.net.

If you enter the logon name as kim@aaengg.net or kim@aaengg.net@automation.net, the
operations will be performed on the second user that is kim@aaengg.net@automation.net.

Action Descrizione

Aggiungi utenti al
gruppo

Consulta Using the Add users to group action alla pagina 1388.

Crea utente Consulta Using the Create user action alla pagina 1388.

Change user password See Change user password action in Active Directory alla pagina 1389

Elimina utente Vedi Delete user action in Active Directory alla pagina 1389

Disattiva account
utente

Vedi Disable user account action in Active Directory alla pagina 1389

Attiva account utente Vedi Enable user account action in Active Directory alla pagina 1390

Ottieni tutti gli utenti di
un gruppo

Vedi Get all users of a group action in Active Directory alla pagina 1390

Ottieni proprietà
utente

Vedi Get user property action in Active Directory alla pagina 1390

Rimuovi utenti dal
gruppo

Consulta Using the Remove users from group action alla pagina 1390.
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Action Descrizione

Rinomina utente Vedi Rename user action in Active Directory alla pagina 1391

Imposta proprietà
utente

Vedi Set user property action in Active Directory alla pagina 1391

Update account
options

See Update account options action in Active Directory alla pagina 1391

Aggiorna dettagli
utente

Vedi Using the Update user details action alla pagina 1392

Using the Add users to group action
Use the Add user to group action to add an existing user to a user-created group.
Ensure there is an existing user and group.
User account operations alla pagina 1386 | Group operations alla pagina 1381
1. In the Actions palette, double-click or drag the Add users to group action from the Active

Directory package.
2. From the Select user field, select one of the following options:

• Add user manually: Enter the Name and Ldap path of the user in the Add user window and
click Add.

• Add users from server: Add an existing user from the server:
a. Enter the host and domain credentials in the Connect to server window and click Connect.
b. In the Select user window, select the user from the Objects panel and click Add user.

The user name and LDAP path of the user is added in the Select user table.

3. Add the user to the specified group by choosing one of the following options:
• Group name: Enter the group name to add the existing user to a specific group.
• Select user group: Add an existing user to a group:

a. Enter the host and domain credentials in the Connect to server window and click Connect.
b. In the Select user window, select the group from the Objects panel to add user to the

destination group and click Apply.

4. Enter the same session name in the Active Directory session that you used in the Connect action.
5. Click Save and Apply.

Using the Create user action
Use the Create user action to configure and activate a new user.
Connect to the Active Directory server.
Using Connect action for Active Directory alla pagina 1383
1. In the Actions palette, double-click or drag the Create user action from the Active Directory

package.
2. In the Session name field, enter the session name that you provided in the Connect action.
3. inserisci un nome utente.

For example, John Smith.
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4. Enter the logon name.
The user will use this value to log in to the account.
For example, john.smith.

5. Enter the user's first name.
6. Opzionale: Enter these user details: last name, display name, initials, email address, description,

department, and title.
7. Select Active user to activate the user.
8. Select the Password settings check box to set the password for the user.
9. Enter the password.

You can select Credential to use a value from the Credential Vault, Variable to use a credential
variable, or Insecure string to manually enter a password.

10. Select the option that enables the user to either change or not change their password at the next
login.
If you choose the Don’t require password change at next login option, you have additional
options to select.
• User can’t change password
• Password doesn’t expire

11. Fai clic su Salva.

Change user password action in Active Directory
The Change user password action in the Active Directory package enables you to change the user
password.

Impostazioni

• Enter the user name. You can select Credential to use a value available in the Credential Vault,
Variable to use a credential variable, or Insecure string to manually enter a user name.

• Enter the new password. You can select Credential to use a value available in the Credential Vault,
Variable to use a credential variable, or Insecure string to manually enter a password.

• Enter the same session name in the Active Directory session that you used in the Connect action.

Delete user action in Active Directory
The Delete user action in the Active Directory package enables you to delete an existing user.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Select whether to search for the user by User name or Logon name.

Nota:  Before removing a user, make certain all unfinished development of bots are checked-in.

Disable user account action in Active Directory
The Disable user account action in the Active Directory package enables you to disable a user account.

Impostazioni

• Enter the same session name as the one you used in the Connect .
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• Select whether to search for the user by User name or Logon name.

Enable user account action in Active Directory
The Enable user account action in Active Directory package allows you to enable a user account.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Select whether to search for the user by User name or Logon name.

Get all users of a group action in Active Directory
The Get all users of a group action in Active Directory package enables you to retrieve a list of all the
users of a group, and assigns the results to a variable.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Enter the group name.
• Specify the return type. Select either the Object Name or LDAP Path option.
• Assign the value to a string variable.

Get user property action in Active Directory
The Get user property action in the Active Directory package enables you to retrieve a specific property
value for a user and assigns the results to a variable.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Select whether to search for the user by User name or Logon name.
• Enter the property.
• Assign value to a string variable.

Using the Remove users from group action
Use the Remove users from group action to remove a user from a group.
Ensure there is an existing user assigned to a group.
Using the Add users to group action alla pagina 1388
1. In the Actions palette, double-click or drag the Remove users from group action from the Active

Directory package.
2. From the Select user field, select one of the following options:

• Add user manually: Enter the Name and Ldap path of the user in the Add user window and
click Add.

• Add users from server: Add an existing user from the server:
a. Enter the host and domain credentials in the Connect to server window and click Connect.
b. In the Select user window, select the user from the Objects panel and click Add user.

The user name and LDAP path of the user is added in the Select user table.
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3. To remove the user from a group, select one of the following options:
• Group name: Enter the group name to remove the existing user from a group.
• Select user group: Remove an existing user from a group.

a. Enter the host and domain credentials in the Connect to server window and click Connect.
b. In the Select user window, select the group from the Objects panel to remove user from the

group and click Apply.

4. Enter the same session name in the Active Directory session as you used in the Connect action.
5. Click Save and Apply

Rename user action in Active Directory
The Rename user action in Active Directory package enables you to rename the user logon name or the
user account name.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Select whether to search for the user by User name or Logon name.
• Enter the name to search for.
• In the New name field, enter the updated name.
• Select from the following options to specify what to update:

• Rename user name
• Rename logon name
• Rename user and logon name

Set user property action in Active Directory
The Set user property action in Active Directory package enables you to assign a value to a user
property, view the current details, and update it.

Impostazioni

• Enter the same session name as the one you used in the Connect .
• Select whether to search for the user by User name or Logon name.
• Enter the property to update.
• Enter the new value.

Update account options action in Active Directory
The Update account options action in Active Directory package enables you to set account attributes for
the user.

Impostazioni

• Specify the user name. You can select Credential to use a value from the Credential Vault, Variable
to use a credential variable, or Insecure string to manually enter a user name.

• Select the status of the user as Active or Inactive.
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• Select an option indicating whether the user can change their password at the next login or not.
If you choose the Don’t require password change at next login option, you have additional
options to select.
• User can’t change password
• Password doesn’t expire

• Enter the same session name in the Active Directory session that you used in the Connect action.

Using the Update user details action
Use this action to update the details of a user.
Connect to the Active Directory server.
Using Connect action for Active Directory alla pagina 1383
1. In the Actions palette, double-click or drag the Update user details action from the Active

Directory package.
2. In the Session name field, enter the session name that you provided in the Connect action.
3. Select whether to search for the user by User name or Logon name.
4. Enter the user's first name.
5. Opzionale: Enter the following user details: last name, display name, initials, email address,

description, department, and title.
6. Fai clic su Salva.

Analyze package
Use the actions in the Analyze package to specify the actions and variables to use in the Bot Insight
dashboard and widgets. The Analyze package enables you to perform transactional analytics for the data
that is logged by the variables when the bot runs.

Nota:  The proxy configuration with authentication is currently not supported.

Actions in the Analyze package

The Analyze package includes the following actions:

Action Descrizione

Chiudi Closes a transaction.
• In the Transaction name field, enter the transaction name that you

provided in the Open action.
• In Dictionary variable, select the following options:

• All user-defined variables: Include all the user-defined string,
numeric, and datetime variables from the bot to populate the Bot
Insight dashboards.

• Manually select the variables to include in the Bot Insight
dashboards.
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Action Descrizione

Apri Opens a transaction. Insert the actions that you want to include for
analysis between the Open and Close actions. In the Transaction name
field, enter a transaction name.

Using the Open and Close actions with the Loop package
• If you want to capture all the data within the loop in the Bot Insight dashboard, use the Open and

Close actions inside the loop.
Esempio: If you are using the For each row in CSV/TXT iterator in the Loop action to read values
from each row in a Microsoft Excel sheet, use the Open and Close actions inside this loop to analyze
and capture the data of each row in the Bot Insight dashboard.

• If you want to capture only the last interpreted data of the loop in the Bot Insight dashboard, use the
Open and Close actions outside the loop.
Esempio: If you are using the For each row in CSV/TXT iterator in the Loop action to read values
from each row in a Microsoft Excel sheet, use the Open and Close actions outside this loop to capture
only the data in the last row of the Excel sheet in the Bot Insight dashboard.

Using the Open and Close actions with the Error handler and If packages
• If you want to analyze and capture error messages during bot execution in the Bot Insight dashboard,

use the Open and Close actions with an Error handler package.
Esempio:
1. Create a bot with multiple If actions within a loop.
2. To capture errors, within every If action, add an Error Handler > Catch action.
3. Inside the loop, after every If action, add the Analyze > Close action to capture the errors inside

every If condition on the Bot Insight dashboard for analysis.

Example task:  See the following topic for an example of building a bot to retrieve data from a website to
create visualizations in Bot Insight: Build a Bot Insight dashboard bot alla pagina 2089. The example includes
using the Open and Close actions inside a loop when using the For each row in CSV/TXT iterator in
the Loop action.

Apigee action package
Use the Apigee package to connect to an Apigee instance to run integrations and collaborate efficiently to
function as one unit.
Apigee Integration offers business organizations of all sizes the tools needed to connect and manage
the multitude of software applications required to support business operations in a digital world. With
Apigee Integration's out-of-the-box triggers, configurable tasks, and friendly user interface, you can create
enterprise-level integrations with ease. All the Automation 360 actions can configured to an API trigger to
invoke executions for Apigee integrations.

Apigee Connect
You can connect to a Google Cloud Platform (GCP) instance using the Apigee Connect action. The GCP
manages access to your Apigee instance.
• Create a GCP account (GCP Cloud) and create a GCloud project.
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• Login to your GCloud account at Google Cloud Project and create a project. If you already have access
to a project, you will see your project here.

• Create an OAuth 2.0 Client ID. A client ID is used to identify a single application to Google's OAuth
Servers. For more details, see Apigee Connect.

You can connect to an Apigee instance using the Apigee Connect action from Automation 360.
1. Open the Google Cloud console.
2. At the top-left, click Menu > APIs & Services > Credentials.
3. Click on an application under OAuth 2.0 Client IDs that you want to connect.

4. Copy the values from Client ID, Client secret, and URI fields.
5. Create a new bot. For more details, see Creazione del primo bot alla pagina 1059.
6. From the Actions pane, select Apigee > Connect and place it under the Start of the bot flow.
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7. To connect using User Account, complete the following steps:
a) In the User Email Address field, enter the email address used to login to the GCloud account.
b) In the Client ID field, paste the Client ID copied from the GCloud. This example uses Insecure

string whereas you can use Credential or Variable options for better security.
c) In the Client Secret field, paste the Client Secret copied from the GCloud.
d) In the Redirect URI field, enter the redirect URI from the GCloud account.
e) Enter Default as the session name.

Nota:  You can use one of the following options to specify the User Email Address/Client
ID/Client secret/ Redirect URI:
• Credenziale: Enables you to use a value in the Credential Vault that contains information about

the User Email Address/Client ID/Client secret/Redirect URI.
• Variabile: Enables you to use a credential variable that contains information about the User Email

Address/Client ID/Client secret/Redirect URI..
• Insecure string: Enables you to enter the User Email Address/Client ID/Client secret/Redirect

URI. User Email Address/Client ID/Client secret/Redirect URI

Apigee Execute Integration
You can configure and execute an integration in Apigee using the Apigee Execute Integration action.
• Create a GCP account (GCP Cloud) and create a GCloud project.
• Login to your GCloud account at Google Cloud Project and create a project. If you already have access

to a project, you will see your project here.
• Create an OAuth 2.0 Client ID. A client ID is used to identify a single application to Google's OAuth

Servers. For more details, see Apigee Connect.

Use the Apigee Execute action to execute an integration in an Apigee instance from Automation 360.
1. Open the Google Cloud console.
2. At the top-left corner, click Menu > APIs & Services > Credentials.
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3. Select the application under OAuth 2.0 client IDs that you want to connect.

4. Copy the values from Client ID, Client secret, and URI fields.
5. Accedi a Control Room.
6. Create a new bot. For more details, See Creazione del primo bot alla pagina 1059.
7. From the Actions pane, select Apigee > Execute integration and place it under the Start of the

bot flow.
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8. Click Discover integrations to configure. Step 1/4: Connect to Apigee X appears. Enter the
following:
a) In the User Email Address field, provide the email address that is used to log in to the GCloud

account.
b) In the Client ID field, paste the Client ID copied from GCloud. In this illustration, Insecure

string is used, while you can use Credential or Variable options for better security.
c) In the Client Secret field, paste the Client Secret copied from GCloud.
d) In the Redirect URI URL, provide a redirect URI from the GCloud account.

Nota:  You can use one of the following options to specify the User Email Address/Client
ID/Client secret/ Redirect URI:
• Credenziale: Enables you to use a value in the Credential Vault that contains information about

the User Email Address/Client ID/Client secret/Redirect URI.
• Variabile: Enables you to use a credential variable that contains information about the User Email

Address/Client ID/Client secret/Redirect URI..
• Insecure string: Enables you to enter the User Email Address/Client ID/Client secret/Redirect

URI. User Email Address/Client ID/Client secret/Redirect URI

9. Fai clic su Connetti.
If the credentials are correct, it gets connected to GCloud and the Step 2/4: Load Integration
screen appears.

10. Select the following in the Step 2/4: Load Integration screen.
a) Click the Project ID drop-down and select the project ID from where you want to load the

integration.
b) Click the Location drop-down and select the location from where you want to load the

integration.

11. Fai clic su Avanti.
Step 3/4: Select an Integration screen appears with all the available integrations.

12. Select an integration from the list.
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13. Fai clic su Avanti.
Step 4/4: Configure my Integration screen appears with all the configuration options.

14. In the Step 4/4: Configure my Integration screen, click the API Trigger drop-down and select
the trigger you want to invoke.

The input parameters are the parameters retrieved from Apigee.
15. Fai clic su Fine.

All the selected options are displayed as parameters in the Apigee: Execute integration action.
16. Click Add new input parameter to manually add the input parameters. You can provide the

parameter value for different parameter types as specified in the following table:

Tipo parametro Valore parametro Esempio

Stringa Specify a string value
stored as a variable.

$str_INString$

Integer Specify a number. 9

Doppio Specify a decimal number. 20.5

JSON Specify a JSON string. $str_JSONString$

String Array Specify string values in an
array.

[a,b,c]

Integer Array Specify integers in an
array.

[11,22,334]

Double Array Specify integers and
decimal numbers in an
array.

[23.5,27,44.5]

Operatore booleano Specify boolean value as
True or False.

Vero

Boolean Array Specify boolean values as
an array.

[true,false]

- - (Manual entry) Specify any value from the
above formats.

17. Enter Default as the session name.
18. To verify the response from the Apigee integration, you can store the response to a variable. Ad

esempio: Execution.

App Integration package
Extract text from a window and save it to a string variable by using the actions in the App Integration
package.
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The App Integration package supports the following technologies:
• UNIX shells, such as Cygwin, PowerShell, and GIT shell
• Windows applications, such as Calculator, Command Prompt, and Notepad
• Java applications that are based on the Standard Widget Toolkit and Abstract Window Toolkit, which

can draw text using Windows text-drawing APIs

The actions in the App Integration package are based on legacy technology and have certain limitations on
specific applications. To seamlessly obtain data from applications and browsers, use the Pacchetto Recorder
alla pagina 1751.

Building bots with actions from the App Integration package

1. Open the application or file from which you want to capture the text using the Application > Open
program/file action.
Application package alla pagina 1402

2. Extract the text using one of the actions from the App Integration package.
3. Use any of the following actions from the String package to manipulate the captured text:

• Extract text: Extracts text from the source string using logical operators.
• Split: Splits the string into multiple strings and stores the output in a list variable.
• Trim: Trims blanks and white spaces from a string.

String package alla pagina 1881

Actions nel package App Integration

Il package App Integration include le seguenti actions:

Action Descrizione

Acquisisci area Consulta Capture area action alla pagina 1399.

Acquisisci testo
scorrevole

Consulta Capture scrollable text action alla pagina 1400.

Capture text of
window

Consulta Capture text of window action alla pagina 1401.

Riferimenti correlati
Screen resolution dependent packages alla pagina 2730
The screen resolution between the Bot Runner and Bot Creator device should be consistent as when
resolution-dependent packages are used to build bots, any screen resolution difference between the Bot
Creator and Bot Runner device will impact the bots during runtime.

Capture area action
The Capture area action enables you to extract text from within the captured area of a window and saves
it to a string variable.
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Impostazioni

Extracts text from within the captured area of a window and saves it to a string variable.
• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.

• Applicazione: seleziona da un elenco di finestre, incluse le finestre del browser, attualmente aperte
sul dispositivo .

• Browser: Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based , and  browsers.

• Variabile: seleziona una variabile finestra esistente per specificare il titolo del titolo della finestra
dell'applicazione.

• Insert a wildcard character (*) in the Window title field to search for window titles that can change.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

• Facoltativo: Seleziona l'opzione Ridimensiona finestra per specificare le dimensioni della finestra.
This option delivers a more reliable bot. It resizes the window to the dimensions at which the task was
recorded, which enhances the bot's ability to identify the target object.

• Click Capture region and select the area to capture.
• In the Save captured text to a variable field, select a string variable.

Capture scrollable text action
The Capture scrollable text action enables you to capture scrollable text from the specified window.
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Impostazioni

Captures scrollable text from the specified window.
• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.

• Applicazione: seleziona da un elenco di finestre, incluse le finestre del browser, attualmente aperte
sul dispositivo .

• Browser: Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based , and  browsers.

• Variabile: seleziona una variabile finestra esistente per specificare il titolo del titolo della finestra
dell'applicazione.

• Insert a wildcard character (*) in the Window title field to search for window titles that can change.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

• (Optional) Select the Resize window option to specify the window dimensions.
This option delivers a more reliable . It resizes the window to the dimensions at which the task was
recorded, which enhances the bot's ability to identify the target object.

• Click Capture coordinate to capture the coordinates of the window or a specific control within the
window.

• In the Save captured text to a variable field, select a string variable.

Nota:  The PowerBuilder application is currently not supported.

Capture text of window action
The Capture text of window action enables you to extract all the text from a window and saves it to a
string variable.
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Impostazioni

Extracts all the text from a window and saves it to a string variable.
• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.

• Applicazione: seleziona da un elenco di finestre, incluse le finestre del browser, attualmente aperte
sul dispositivo .

• Browser: Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based , and  browsers.

• Variabile: seleziona una variabile finestra esistente per specificare il titolo del titolo della finestra
dell'applicazione.

• (Optional) Select the Resize window option to specify the window dimensions.
This option delivers a more reliable . It resizes the window to the dimensions at which the task was
recorded, which enhances the bot's ability to identify the target object.

• In the Save captured text to a variable field, select a string variable.

Application package
Use the Open Program/File action in the Application package to launch an application or a file. This
action supports .exe, .bat, script files, or shortcut paths.

Actions nel package Application

Il package Application include le seguenti action:

Action Descrizione

Apri programma/file Consulta Open program/file action alla pagina
1402.

Open program/file action
The Open Program/File action in the Application enables you to launch an application or a file.

Impostazioni

Opens an application or file.
• Enter the name of the application or file, or insert a variable. For example, chrome.exe.

Nota:  You can also enter the full file path in this field.

• Facoltativo: Enter the location of the file that you want to use to open the application in the Start in
path field.
For example, C:\Program Files (x86)\Google\Chrome\Application\

• Facoltativo: In the Parameters field, specify the parameters or arguments you want to pass to the
program.
For example, if you are using the command line, enter the arguments in this field.
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When you enter a file path in the Location of the program/file field or Start in path field and use
a backslash (\) character to separate the file path, when you save the bot, the backslash (\) character is
changed to forward slash (/). To supports multiple platforms, Automation 360 converts the file paths to a
relative path, and the bot uses a forward slash (/) to separate the file paths.

Nota:  Your bots will continue to run successfully even when the backslash (\) is changed to a forward
slash (/) during bot execution.

AWS Comprehend NLP package
The AWS Comprehend NLPpackage contains actions that enable you to connect to and consume the
Amazon Comprehend API to identify the language, sentiment, key phrases, and entities.

Importante:  This is a beta package and is currently not available with the Automation 360 Enterprise
and Cloud editions.

Prima di iniziare

You require the following information for an existing AWS account to use these actions:
• Access key and Secret key: Credentials that authenticate Automation 360 with your AWS account.

See Access Keys (Access Key ID and Secret Access Key).
• Region: Specifies the AWS service endpoint.

See AWS Service Endpoints.

Actions in the AWS Comprehend NLP package

Action Descrizione

Detect language Identifies the language of the provided content and returns it in ISO
639-1 language code. The output is stored in a string variable. This action
supports over 100 languages. For the full list, see Detect the Dominant
Language.

Get key phrases Identifies the main points and returns a list of key phrases. For example, if
the input text is about a basketball game, this action returns the names of
teams, the name of the venue, and the final score.

Get named entities Identifies the entities in the provided content such as people, places,
organizations, date/time, quantities, branded products, and book titles.
The output is stored in a dictionary variable, where each name is a key,
and the corresponding entity is the value.

Get sentiment Analyzes the provided content and returns the overall sentiment and
scores for all possible sentiments. An example output of the dictionary
values:
POSITIVE {Positive: 0.66238534,Negative:
 0.0013064129,Neutral: 0.33621928,Mixed: 8.892125E-5}

The output is stored in a dictionary variable containing two keys and their
corresponding values: sentiment and score.
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Boomi action package
Boomi Atomsphere is a leading industry on-demand integration service available as a platform-as-a-service
(iPaaS) offering. With the Boomi actions package, you can start a session in Boomi from Automation 360
and perform general tasks in Boomi.

Nota:  The Boomi package is only available via the Bot Store and is not yet generally available in
Automation 360. This package is currently undergoing final testing, after which it is anticipated to be
generally released as part of Automation 360.

Without extensive training or specialized technical skills, you can build integration flows in Boomi using
drag-and-drop. A multitude of connectors to external systems are available out of the box. It simplifies
typical integration functions such as transforming between various data formats (EDI, CSV, XML, JSON,
and so on) and handling different transport mechanisms (file, FTP, HTTP, and so on). The Boomi action
package uses the Boomi APIs to integrate Automation 360 with Boomi.
To perform any action in Boomi using Automation 360,RPA developers need to establish a session with
Boomi. After you establish a session is established, you can execute a process from the Automation 360.
Additionally, you can list the Atoms and Processes.
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Boomi Session Start action
With the Boomi Session Start action, you can connect to a particular Boomi instance using a valid
Account ID to begin a session.
Make sure you have an account to log in to the Boomi Atomsphere Platform. If you are new to Boomi,
go to the Boomi website at Boomi Platform and click the Free Trial link on the banner at the top of the
page.
1. Log in to the Boomi Atomsphere Platform (Boomi Platform).
2. Navigate to Settings > Account Information and Setup.

You will notice the Account ID.
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3. Copy the Account ID.
4. Log in to the Automation 360 Control Room.
5. Create a new .

a) Accedi alla tua istanza di .
b) Nel pannello di sinistra, fai clic su Automazione.
c) Fai clic su Crea nuovo > Bot.
d) In the Create Task Bot window, enter the  name.
e) Accept the default folder location: \Bots\

To change the default  storage location, click Choose and follow the prompts.
f) Fai clic su Crea e modifica.
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6. From the Actions pane, select Boomi > Session Start and place it under the Start of the bot flow.
Boomi information Opzione

Boomi Account ID/Boomi Login/ Boomi
password

Select one of the following options to specify
the Boomi Account ID/Boomi Login/Boomi
password:
• Credenziale: Enables you to use a value

available in the Credential Vault that contains
information about the Boomi Account ID/
Boomi Login/Boomi password.

• Variabile: Enables you to use a credential
variable that contains information about
the Boomi Account ID/Boomi Login/Boomi
password.

• Insecure string: Enables you to enter
the Boomi Account ID/Boomi Login/Boomi
password for the Boomi Session Start.

a) In the Boomi Account ID field, paste the Account ID copied from the Boomi Atomsphere
Platform.

b) In the Boomi Login field, enter the Email Address used to log in to the Boomi Atomsphere
Platform.

c) In the Boomi Password field, enter the Password used to log in to the Boomi Atomsphere
Platform.
The following example shows how Insecure string is used for the Session Start information. For
better security, you can use either the Credential or Variable options.
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Boomi List Atoms action
With the Boomi List Atoms action, you can list all the Atoms associated with a Boomi instance.

Nota:  Ensure that you have started a Boomi session before initiating any Boomi action. For more details,
see Boomi Session Start action alla pagina 1405.
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An Atom is a single tenant runtime engine and cannot be used by multiple accounts. It is a light-weight
Java application that runs on a single node only and does not provide high availability. The following
procedure describes how to list all the Atoms of a Boomi instance:
1. From the Actions pane, select Boomi > List Atoms and place it in the canvas.

2. Make sure the Session name field is set to Default. Default uses the current session that has been
established using the Boomi Session Start action alla pagina 1405.

3. Create a variable to store the response. In this example, the response is saved in a variable named
jListAtoms.

You can use a message box action to view the list of Atoms. The message box displays the list of Atoms
similar to the following image:
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Boomi Convert Atom list to CSV action
With the Boomi Convert Atom List to CSV action, you can convert an Atom list associated with a Boomi
instance into a CSV format.

Nota:  Ensure that you have started a Boomi session before initiating any Boomi action. For more details,
see Boomi Session Start action alla pagina 1405.
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The following procedure describes how to convert an Atom list to CSV in a Boomi instance:
1. From the Actions pane, select Boomi > Convert Atom List to CSV and place it in the canvas.

2. Enter a JSON Atom List stored in a variable. For more information on storing a JSON Atom List, see
Boomi List Atoms action alla pagina 1408.

3. Create a variable to store the response. In this example, the response is saved in a variable named
AtomCSV.

You can use a message box action, to view the CSV. The message box displays the list of Atoms converted
into a CSV similar to the following image:
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Boomi List Processes action
With the Boomi List Processes action, you can list all the Processes associated with a Boomi instance.
The process is the central component in Boomi Integration.

Nota:  Ensure that you have started a Boomi session before initiating any Boomi action. For more details,
see Boomi Session Start action alla pagina 1405.

A process is a graphical representation of the path that a document takes from the point at which it is
received or retrieved to the point at which it is sent to one or more destinations. Processes in Boomi are
depicted with a left-to-right series of shapes and connected together similar to a flow chart. It illustrates
the steps required to transform, route, or manipulate the data from the source to the destination.
Processes use connectors to retrieve and send data. Processes are deployed to the atom (a dynamic
runtime engine). Once processes have been deployed, the atom contains all the components required to
execute the integration processes from start to finish including:
• Connectors
• Transformation rules
• Decision handling
• Processing logic

© 2023 Automation Anywhere. All rights reserved.     1412



    Automation Anywhere - Crea

The following procedure describes how to list all the Processes of a Boomi instance:
1. From the Actions pane, select Boomi > List Processes and place it in the canvas.

2. Make sure the Session name field is set to Default. Default uses the current session that has been
established using the Boomi Session Start action alla pagina 1405.

3. Create a variable to store the response. In this example, the response is saved in a variable named
jListProcesses.

You can use a message box action, to view the list of Processes. The message box displays the list of
Processes similar to the following image:
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Boomi Convert Process List to CSV action
With the Boomi Convert Process List to CSV action, you can convert a Process list associated with a
Boomi instance into a CSV format.

Nota:  Ensure that you have started a Boomi session before initiating any Boomi action. For more details,
see Boomi Session Start action alla pagina 1405.
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The following procedure describes how to convert a Process list to CSV in a Boomi instance:
1. From the Actions pane, select Boomi > Convert Process List to CSV and place it in the canvas.

2. Enter a JSON Process List stored in a variable. For more information on storing a JSON Processes List,
see Boomi List Processes action alla pagina 1412.

3. Create a variable to store the response. In this example, the response is saved in a variable named
ProcessesCSV.

You can use a message box action, to view the CSV. The message box displays the list of Processes
converted into a CSV similar to the following image:
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Boomi Convert Process List to Table action
With the Boomi Convert Process List to Table action, you can convert a Process list associated with a
Boomi instance into a Table format.

Nota:  Ensure that you have started a Boomi session before initiating any Boomi action. For more details,
see Boomi Session Start action alla pagina 1405.
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The following procedure describes how to convert a Process list to table in a Boomi instance:
1. From the Actions pane, select Boomi > Convert Process List to Table and place it in the canvas.

2. Enter a JSON Process List stored in a variable. For more information on storing a JSON Process List,
see Boomi List Processes action alla pagina 1412

3. Create a variable to store the response. In this example, the response is saved in a variable named
ProcessesTable.

You can use a message box action, to view the CSV. The message box displays a cell from the list of
Processes converted into a Table similar to the following image:
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Boomi Execute Process action
With the Boomi Execute Process action, you can execute a process associated with a Boomi Atom.

Nota:  Ensure that you have started a Boomi session before initiating any Boomi action. For more details,
see Boomi Session Start action alla pagina 1405.

The following procedure describes how to execute a process associated to a Boomi atom:
1. From the Actions pane, select Boomi > Execute Process and place it in the canvas.

2. Make sure the Session name field is set to Default. Default uses the current session that has been
established using the Boomi Session Start action alla pagina 1405.

3. In the Process ID field, enter a process ID that you want to execute. For more information on
retrieving the process ID, see Boomi List Processes action alla pagina 1412.
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4. In the Atom ID field, enter an atom ID to which the process is associated. For more details, see
Boomi List Atoms action alla pagina 1408.

5. In the Process Properties field (optional), enter the process properties you want to edit.

You can save the response into a variable. In this example, the response is saved in a variable named
ExecuteProcess. Use a message box to view the content of the variable. The API response is converted
into a string before it is passed to the message box. The message box displays the execute process
response of the similar to the following image:

Boomi List Execution Records action
With the Boomi List Execution Records action, you can list all the execution records associated with a
Boomi instance.

Nota:  Ensure that you have started a Boomi session before initiating any Boomi action. For more details,
see Boomi Session Start action alla pagina 1405.
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The following procedure describes how to list the execution records of a Boomi instance:
1. From the Actions pane, select Boomi > List Execution Records and place it in the canvas.

2. Make sure the Session name field is set to Default. Default uses the current session that has been
established using the Boomi Session Start action alla pagina 1405.

3. Create a variable to store the response. In this example, the response is saved in a variable named
ExecutionRecords.

You can use a Data Table: Write to file action, to view the execution records.
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Boomi Session End
With the Boomi Session End action, you can end an established Boomi session.

Nota:  Ensure that you have started a Boomi session before initiating any Boomi action. For more details,
see Boomi Session Start action alla pagina 1405.

The following procedure describes how to end an existing session of a Boomi instance:
1. From the Actions pane, select Boomi > Session End and place it at the end of the bot flow.

2. Make sure the Session name field is set to Default. Default uses the current session that has been
established using the Boomi Session Start action alla pagina 1405.

Boolean package
The Boolean package contains actions that enable you to do various operations on boolean values.

Actions in the Boolean package

The actions in the Boolean package accept a variable as an input and assign the output to a variable.
These actions enable you to compare two boolean values, convert a boolean value to a string or numeric
value, and convert a string value to a boolean value.
The Boolean package includes the following actions:
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Azione Descrizione

Assegna Vedi Assign action in Boolean alla pagina 1422

Confronta con Vedi Compare to action in Boolean alla pagina 1423

Uguale a Vedi Equal to action in Boolean alla pagina 1423

Inverti Vedi Invert action in Boolean alla pagina 1423

To number Vedi To number action in Boolean alla pagina 1423

To string Vedi To string action in Boolean alla pagina 1423

Compare results for the Compare to action
The following table illustrates how two boolean values are compared using the Compare to action and
their output:

Boolean value 1 Boolean value 2 Compare result

True True 0

True False 1

False True -1

False False 0

Compare results for the Equal to action
The following table illustrates how two boolean values are compared using the Equal to action and their
output:

Boolean value 1 Boolean value 2 Equal result

True True True

True False False

False True False

False False True

Assign action in Boolean
The Assign action in the Boolean package enables you to assign a constant value (True or False) or a user-
defined value to a boolean value.

Impostazioni

• In the Select the source boolean variable/value field, select one of the following options:
• Constant values: Enables you to assign a constant value (True or False).
• Variable value: Enables you to assign a user-defined value to a boolean value.

• In the Select the destination boolean variable field, select a boolean variable to store the output.
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Compare to action in Boolean
The Compare to action in the Boolean package enables you to compare two Boolean values and assigns
the output to a number variable.

Impostazioni

• In the Select the first boolean variable field, specify a boolean variable.
• In the Select the second boolean variable field, specify a boolean variable that the first boolean

variable has to be compared with.
• In the Assign the output to a number variable field, select a variable to store the output.

Equal to action in Boolean
The Equal to action in the Boolean package enables you to verify whether the two boolean values are
equal or not, and assigns the output to a boolean variable.

Impostazioni

• In the Select the first boolean variable field, specify a boolean variable.
• In the Select the second boolean variable field, specify a boolean variable that the first boolean

variable has to be compared with.
• In the Select the boolean variable to store the result field, select a variable to store the output.

Invert action in Boolean
The Invert action in the Boolean package enables you to convert a boolean value to the opposite value
(True to False and False to True), and assigns the output to a variable.

Impostazioni

• In the Select the boolean variable to be inverted, select the boolean value to convert. Choose
from False, True, or a Variable.

• In the Assign the output to field, select a boolean variable to store the converted value.

To number action in Boolean
The To number action in the Boolean package enables you to convert a boolean value to a numeric value.
This action converts True to 1 and False to 0.

Impostazioni

• In the Select boolean variable field, select the boolean variable that you want to convert.
• In the Assign the output to variable field, select the number variable to store the converted value.

To string action in Boolean
The To string action in the Boolean package enables you to convert a boolean value to a string value.
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Impostazioni

• In the Select boolean variable field, select the boolean variable that you want to convert.
• In the Assign the output to variable field, select the number variable to store the converted value.

Bot migration package
The Bot migration package enables you to migrate Enterprise 10 and Enterprise 11 bots to Automation
360 format. The package also enables you to convert Enterprise 10, Enterprise 11, or Automation 360
bots that use Internet Explorer to Microsoft Edge with IE mode. This package is used internally by the Bot
Migration Wizard and the Update Bot wizard.
Consulta Versioni Control Room supportate per la migrazione alla pagina 1136.

Importante:  We recommend that you use the Bot Migration Wizard to migrate Enterprise 11 or
Enterprise 10 bots to Automation 360.
The Bot migration package does not migrate dependencies and other entities such as credential
variables, AAApplicationPath system variable, and global values that are required to run the migrated
bot.

Action in the Bot migration package

The Bot migration package includes the following action:

Action Descrizione

Migrate legacy bot See Migrate legacy bot action.

Update bot See Update bot action.

Concetti correlati
Migrazione a Automation 360 alla pagina 1126

Migrate legacy bot action in Bot Migration
The Migrate legacy bot action enables you to migrate the Enterprise 11 and Enterprise 10 bot files to
Automation 360 format and uploads the migrated file to the specified location in your private repository
with the same name as .atmx and .mbot file.

Impostazioni

Starting from Automation 360 v.24R2 release for IE EOL, the Migrate bot action is renamed as Migrate
legacy bot.
This action only migrates the bot you specify, but does not migrate its dependencies. Dependencies are the
bots and other files that are required to run the bot. You must migrate the dependent bots separately and
upload other files manually to Control Room.
All the bots migrated using the Bot migration package are stored in the Bots folder in Automation 360.
If you have to migrate a parent bot and its child bots separately using the Bot migration package, you
must create the same folder structure as in Enterprise 11 or Enterprise 10 and move the dependent bots to
these folders for the parent bot to run successfully.
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• Use the Control Room file, Desktop file, or Variable tab to specify the location of the bot you want
to migrate.

• In the Output folder path field, specify the location where you want to save the log files generated
for the bot migration.

Nota:  Ensure that the location you have specified exists on the device.

The system does not upload the bot if it fails during the migration process. The system creates an
XML report at the same location that provides information that helps you to troubleshoot if the system
encounters an error during migrating the bot file.

• Select the Overwrite the file if exists check box to overwrite an existing bot file.
• Set a time-out value for migrating the bots within the range of 3 through 90 minutes (default value is

90 minutes).
If the migration of any specific bot is not completed within the set time, the bot will display a timeout
message with the reason for the failure and the migration process will move on to the next bot.

• If you are migrating Enterprise 10 and Enterprise 11 bots that are built using Internet Explorer, select
the Convert bots built using Internet Explorer to Edge with Internet Explorer mode option to
convert them to Microsoft Edge with IE mode.

Update bot action in Bot Migration
The Update bot action enables you to convert Automation 360 bots that are built using Internet Explorer
browser to Microsoft Edge Chromium with IE mode.

Impostazioni

This action is internally used by the Update Bot wizard to convert the bots .

Nota:  This action cannot be used manually in a new or an existing bot for bot conversion.

• From the Select task bot file field, enter the name of the TaskBot file that you want to upload or
select an existing used variable.

• From the Select bot version to update option, select either the latest version of the bot or the bot
version that is provided on the production label.

Browser package
Il Browser package contiene actions che consentono di scaricare file, trovare collegamenti interrotti
e avviare un sito Web. Questo package supporta i browser Google Chrome, Microsoft Edge basato su
Chromium e Internet Explorer.

Actions nel package Browser

Il package Browser include le seguenti actions:

Action Descrizione

Call a JavaScript
function

Vedi Call a JavaScript function action alla pagina 1426

Close See Close action alla pagina 1428

Scarica file Vedi Download files action alla pagina 1429
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Action Descrizione

Trova link interrotti Vedi Using Find broken links action alla pagina 1429

Ottieni codice sorgente Vedi Get source code action alla pagina 1430

Vai indietro Vedi Go back action alla pagina 1430

Apri Vedi Open action alla pagina 1431

Esegui JavaScript Vedi Run JavaScript action alla pagina 1433

Nota:
• Quando si esegue una qualsiasi action dal package Browser sulla scheda browser Internet Explorer,

se più schede con lo stesso titolo sono aperte nella stessa finestra del browser, il titolo corrispondente
non viene cercato in sequenza a partire dalla prima scheda. L'attivazione della scheda e l'action browser
potrebbero essere eseguite su diverse schede corrispondenti in questo caso.

• Se lo stesso titolo di scheda è presente in finestre diverse, allora l'action viene eseguita su una scheda
con un titolo corrispondente in qualsiasi finestra.

Call a JavaScript function action
The Call a JavaScript function action in the Browser package enables you to call an exisiting JavaScript
function directly in a webpage or in an iFrame within a webpage.

Configure the settings

Nota:  This action supports Google Chrome and Chromium-based Microsoft Edge browsers.

1. Select the browser tab from the list of active supported browser tabs or insert a window variable.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
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Ensure that you use valid regex patterns.

2. Facoltativo: Per acquisire gli iFrame, utilizza l'opzione Acquisisci oggetto.

Nota:  You can use the Capture object feature to call and run an existing JavaScript function inside
an iFrame.

3. In the Function name field, specify the name of the existing JavaScript function that you want to
call.

4. Facoltativo: In the Arguments section, click Add argument to add arguments that must be
passed to call the JavaScript function.
a. In the Argument details dialog box, select the Argument type required for the specific

argument.
b. In the value field, enter the corresponding value or variable of the selected type that you want to

pass.

Nota:  All string values in arguments are passed as is without any character being converted or
escaped.

5. Facoltativo: In the Time out after field, enter the number of seconds the bot must wait for the
browser action to complete.

Nota:  Inserisci un valore di timeout di almeno 9 secondi.

6. In the Return Type field, select the type of value returned by the JavaScript function.

Nota:  If the function does not return anything, in the Return Type field, select None.

7. For any Return type except None, in the Save the outcome to a variable field, select a variable
for selected Return type to hold the JavaScript function output.

Crea variabile

To create a variable for selected Return type, perform the following steps:
1. Click the Create variable symbol next to the Save the outcome to a variable field.

A Create variable dialog opens with default variable name for the type of variable selected.
2. Facoltativo: Specify the variable information in the Description field.
3. Facoltativo: Specify a value in the Default value field.
4. Click Create & select to select the newly created variable.

Supported JavaScript types in Argument and Return type fields

The following JavaScript types are supported:
• String, Number, and Boolean JavaScript types which correspond to the same variable types in bot

variables.
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• Array JavaScript type which corresponds to the List variable type in bot variables.
• Object JavaScript type which corresponds to the Dictionary variable type in bot variables.

Close action
Use the Close action in the Browser package to close a browser window or tab.

Impostazioni

Nota:  Questo  supporta i browser ,  basato su Chromium e .

• Seleziona per chiudere la scheda, la finestra o tutti i browser:
• Scheda: Chiude la scheda selezionata. Seleziona la scheda dall'elenco di schede attive del browser

supportate o inserisci una variabile finestra.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the
regular expression condition as either String or a Pattern and then enter the value. By default, the
Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will
be identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names
starting with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only
those window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that
when you add the string input as *-title, the application with the specific title is open. The
asterisk (*) is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a
window title in any , the  might encounter a run time error because the input value *-title is
incorrect.
Ensure that you use valid regex patterns.

• Finestra: Chiude la finestra della scheda selezionata. Select the window from the list of active
supported windows or insert a window variable.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the
regular expression condition as either String or a Pattern and then enter the value. By default, the
Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will
be identified only with matching letter case (case-sensitive).
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For example, you can enter the String value as ((\w*)-Notepad for all window title names
starting with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only
those window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that
when you add the string input as *-title, the application with the specific title is open. The
asterisk (*) is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a
window title in any , the  might encounter a run time error because the input value *-title is
incorrect.
Ensure that you use valid regex patterns.

• Tutti i browser: Closes all open browser windows for supported browsers.

• Facoltativo: Nel campo Timeout dopo, inserisci il numero di secondi che il bot deve attendere prima
che la finestra o la scheda del browser si chiudano prima che il bot non riesca.

Nota:  Inserisci un valore di timeout di almeno 9 secondi.

Download files action
The Download files action in the Browser package downloads and saves files from specified URLs and URLs
that require NTLM authentication.

Impostazioni

Scarica e salva i file da URL specificati e da URL che richiedono l'autenticazione NTLM.
• Specifica la URL del file che desideri scaricare.
• Nel campo Salva nella posizione, immetti la posizione in cui desideri salvare il file.

Using Find broken links action
The Find broken links action finds broken links on a specific page or website, stores the output to a CSV
file. Optionally, you can specify encoding for the output data.
Follow these steps to find broken links:
1. In the Actions palette, double-click or drag the Find broken links action from the Browser

package.
2. In the Page or URL field, enter the URL of the page or website.
3. In the Scope option, choose either check only this page or check the whole site.
4. In the Save list to location field, specify the location of the CSV file.
5. Select the Append to already existing csv file check box if you want to append the data to an

existing CSV file.
6. Seleziona un'opzione nell'elenco Codifica per specificare la codifica che desideri applicare al file.

• ANSI
• Unicode
• UTF-8
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7. In the Number of parallel threads field, enter the number of parallel threads you want to run
simultaneously.
Parallel threads means multiple processes running simultaneously to perform the same task which
results in faster execution. Higher the number of parallel threads faster the execution of a task
execution. For example, if 10 threads complete a task in two minutes, 20 threads compete a task in
one minute.

Nota:  The maximum value you can provide in the field is 99.

8. In the Time out field, specify the maximum time the system must wait to receive a response from
each URL link.

9. Fai clic su Salva.

Get source code action
The Get source code action retrieves the source code of a web page and an iFrame on a web page and
saves the output to a string variable.

Impostazioni

Nota:  Questo  supporta i browser ,  basato su Chromium e .

• Seleziona la scheda dall'elenco di schede attive del browser supportate o inserisci una variabile finestra.
• Facoltativo: Per acquisire gli iFrame, utilizza l'opzione Acquisisci oggetto.

Nota:
• La funzionalità Acquisisci oggetto viene utilizzata solo per recuperare il codice sorgente di un

iFrame. Se non si acquisisce nulla sulla finestra, viene recuperato il codice sorgente dell'intera
finestra.

• Il recupero del codice sorgente di un iFrame è attualmente supportato solo sul browser Google
Chrome.

• Facoltativo: In the Time out after field, enter the number of seconds the  must wait for the browser
action to complete.

Recommended:  Inserisci un valore di timeout di almeno 9 secondi.

• Facoltativo: Seleziona una variabile per mantenere l'output . La  mostra un nome descrittivo
predefinito della variabile. If you create several output variables, subsequent variable names are
appended with a -1, -2, -3, and so on to avoid duplication.

Go back action
The Go back action returns to a web page previously visited in the current tab. Questa action simula il clic
sull'opzione Indietro del browser.

Impostazioni

Nota:  Questo  supporta i browser ,  basato su Chromium e .
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• Seleziona la scheda dall'elenco di schede attive del browser supportate o inserisci una variabile finestra.

Nota:  Quando selezioni la scheda Internet Explorer dall'elenco delle schede attive, e se il titolo della
scheda selezionata o qualsiasi titolo della scheda intermedia durante l'esecuzione dell'action Vai
indietro ha più di 60 caratteri, allora i primi 60 caratteri vengono usati come confronto per trovare il
titolo della scheda corrispondente.

Recommendation:  Quando esegui l'action sulla scheda browser, verifica che sia aperta una sola
scheda nella finestra del browser con il titolo della scheda corrispondente. Questo per assicurare che
durante l'esecuzione dell'action, non ci sia un titolo di scheda intermedia corrispondente a un altro titolo
di scheda nella stessa finestra.

• Nel campo Numero di passaggi precedenti, immetti il numero di pagine a cui tornare indietro.
• Facoltativo: Seleziona l'opzione Genera un errore se il numero di passaggi è superiore a

quello della cronologia per fare in modo che il bot non vada a buon fine se il numero inserito nel
passaggio precedente è maggiore del numero di pagine visitate.
Se questa opzione non viene selezionata, quando il bot viene eseguito, la scheda tornerà alla prima
pagina web aperta.

• Facoltativo: In the Time out after field, enter the number of seconds the  must wait for the browser
action to complete.

Recommended:  Inserisci un valore di timeout di almeno 9 secondi.

Open action
The Open action opens the browser to a specific web page.

Impostazioni

• Seleziona per aprire la pagina web in una scheda esistente, in una nuova scheda o in una nuova
finestra:
• Scheda esistente: Apre la pagina web in una scheda attualmente aperta. Select the tab from

the list of active supported browser tabs, the Last used browser tab option, or insert a window
variable.

Nota:  This option supports , Chromium-based , and  browsers.

Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the
regular expression condition as either String or a Pattern and then enter the value. By default, the
Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will
be identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names
starting with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only
those window titles that match this pattern.

Nota:
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• When you use a regular expression of type String with -title as the input value for a window
title in any , the  might encounter a run time error. To prevent the run time error, ensure that
when you add the string input as *-title, the application with the specific title is open. The
asterisk (*) is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a
window title in any , the  might encounter a run time error because the input value *-title is
incorrect.
Ensure that you use valid regex patterns.

• Nuova scheda: Apre la pagina web in una nuova scheda. Seleziona la scheda dall'elenco di schede
attive del browser supportate o inserisci una variabile finestra.

Nota:
• Questa opzione supporta i browser Google Chrome, Microsoft Edge basato su Chronimum e

Internet Explorer.
• Quando si esegue l'action sulla scheda Internet Explorer, l'action viene eseguita nella scheda

corrispondente solo quando lo stato è pronto.

Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the
regular expression condition as either String or a Pattern and then enter the value. By default, the
Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will
be identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names
starting with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only
those window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that
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when you add the string input as *-title, the application with the specific title is open. The
asterisk (*) is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a
window title in any , the  might encounter a run time error because the input value *-title is
incorrect.
Ensure that you use valid regex patterns.

• Nuova finestra: Apre la pagina web in una nuova finestra di un browser specifico.
Seleziona il browser tra le seguenti opzioni dall'elenco:
• Browser predefinito

Assicurati che Google Chrome, Microsoft Edge o Internet Explorer sia impostato come browser
predefinito.

Nota:  Se un browser non elencato è impostato come browser predefinito per il dispositivo, il bot
potrebbe riscontrare un errore.

• Google Chrome
• Internet Explorer
• Microsoft Edge
• Mozilla Firefox

• Inserisci il collegamento alla pagina web da aprire.

Nota:  For web pages to open properly, we recommend that you specify a URL with the protocol
information, such as http, https, or file.

• Facoltativo: Nel campo Timeout dopo, inserisci il numero di secondi che il bot deve attendere il
caricamento della pagina web specificata prima che il bot non riesca.

Nota:  Inserisci un valore di timeout di almeno 9 secondi.

Nota:
• Il timeout è applicabile solo per le opzioni Nuova scheda e Scheda esistente.
• Per il browser Internet Explorer, il bot viene eseguito anche se la pagina web non viene caricata

completamente dopo aver atteso il timeout.

Run JavaScript action
The Run JavaScript action in the Browser package executes JavaScript on a web page and on web pages
that have iFrames.

Impostazioni

Nota:
• This action supports Google Chrome and Chromium-based Microsoft Edge browsers.
• When you use this action to execute a JavaScript that contains a single-line comment as the last line

of the JavaScript (for example, //comment), it can cause the Automation Anywhere plugin to become
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unstable. We recommend that you either remove the comment at the end of the JavaScript or convert it
to a multi-line comment (for example, /* comment */).

• Select the browser tab from the list of active supported browser tabs or insert a window variable.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

• Choose one of the following options:
• Nell'opzione Importa file esistente, seleziona un file  esistente.

Nota:  If you are uploading a script from a file on your desktop, the file and any dependencies must
be in a standalone folder. When you select a file for upload, all files and folders at the same folder
level are uploaded.

• Nell'opzione Input manuale, immetti .

• Facoltativo: Per acquisire gli iFrame, utilizza l'opzione Acquisisci oggetto.

Nota:
• La funzionalità Acquisisci oggetto viene utilizzata solo per eseguire JavaScript all'interno di un

iFrame.
• Il supporto per eseguire JavaScript all'interno di un iFrame è disponibile solo per il browser Google

Chrome.

• Facoltativo: In the Time out after field, enter the number of seconds the  must wait for the browser
action to complete.

Recommended:  Inserisci un valore di timeout di almeno 9 secondi.

• Facoltativo: In the Save the outcome to a variable field, select a variable to hold the action
output. La Control Room mostra un nome descrittivo predefinito della variabile. If you create several
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output variables, subsequent variable names are appended with a -1, -2, -3, and so on to avoid
duplication.

Nota:  This action supports String, Number, and Boolean JavaScript types which correspond to the same
variable types in bot variables, or to the bot variable type Any.

Recommendation:
• Non usare Jquery con il JavaScript package.
• Utilizza le actions Prova/Cattura da Error handler nella funzione JavaScript.
• Richiama una funzione JavaScript prima di dichiararla.

Watch the following video on using the Run JavaScript action from the Browser package to execute
JavaScript directly within an existing browser window:

Informazioni correlate
Executing a JavaScript function on Chrome (A-People login required)

Clipboard package
The Clipboard package contains actions that enable you to automate using the Windows clipboard. Use the
actions to copy a string value to the clipboard, copy the clipboard value to a string variable, and clear the
clipboard.

Actions nel package Clipboard

Il package Clipboard include le seguenti actions:

Action Descrizione

Cancella Consulta Clear action in Clipboard alla pagina 1435.

Copia da Consulta Copy from action in Clipboard alla pagina 1435.

Copia in Consulta Copy to action in Clipboard alla pagina 1436.

Clear action in Clipboard
The Clear action in the Clipboard package enables you to clear the clipboard.

Impostazioni

This action will remove any value that is stored in the clipboard.

Copy from action in Clipboard
The Copy from action in the Clipboard package enables you to retrieve the values stored in the clipboard.
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Impostazioni

This action enables you to retrieve the values stored in the clipboard and store it in the string variable that
you select from the Assign the output to variable list. This action also enables you to pass the value
from the clipboard to other actions.

Copy to action in Clipboard
The Copy to action in the Clipboard package enables you to store values in the clipboard.

Impostazioni

You can either enter the value or specify the string variable that contains the value in the Value field.

package Credenziale
Nel package Credenziale, puoi utilizzare l'action Assegna per assegnare una stringa non sicura o una
variabile direttamente alla variabile credenziale.

Actions nel package Credenziale

Il package Credenziale include la seguente action:

Nota:
• The credential variables support the retry mechanism. When you create a bot that uses credential

variables, if the bot fails during run time to retrieve those variables from the Credential Vault because
the Control Room is disconnected or the Control Room services stop intermittently, then the bot tries
three times to retrieve the credential variables from the Credential Vault.

• While the Convert credential to string action is listed on the Credential package details page, it is
not available for use from the actions list in the Bot editor. This is because the action should be used
only for migration and not for other scenarios because it introduces a security risk.

Action Descrizione

Assegna Imposta il valore di una variabile credenziale.
• È possibile selezionare Credenziale per utilizzare un valore dal

Credential Vault, Variabile per utilizzare una variabile credenziale o
Stringa non sicura per inserire manualmente una variabile.

• Nel campo Salva il valore in una variabile, seleziona una variabile
stringa per contenere il valore restituito.

CSV/TXT package
The CSV/TXT package contains actions that enable you to open a CSV or text file, read data from that
file, and assign the data to a Table variable. This package supports files encoded in ANSI, Unicode, UTF-8,
or Windows-1251, and can process up to one million records.
Perform the following actions within the CSV/TXT package as part of using the set of available actions:

© 2023 Automation Anywhere. All rights reserved.     1436



    Automation Anywhere - Crea

1. Open the file to be used in the automation. Vedi Utilizzo dell'action Apri per file CSV/TXT alla pagina
1437.

Nota:  For files containing large data sets, use actions from the Database package to automate
create, read, and update operations. Consulta Utilizzo dell'action Connetti per il database alla pagina
1451.

2. Use the Read action to retrieve values from a CSV or TXT file and store them in a Table variable.
Consulta Using Read action alla pagina 1438.
To retrieve values row by row, use the For each row in CSV/TXT iterator in the Loop action to read
values from each row in the file and assign it to a record variable. Consulta Using the For each row in
CSV/TXT iterator alla pagina 1689.

Nota:  The Read action and For each row in CSV/TXT iterator only support CSV/TXT files that
conform to the RFC 4180 standard. For more information about the standard, see Common format and
MIME type for CSV files.

3. After you have automated the CSV/TXT-related tasks, close the file using the Close action. Enter the
session name that was used to open the file with the Open action.

Riferimenti correlati
Loop package alla pagina 1681
Utilizza il Loop Pacchetto per eseguire una sequenza di actions ripetutamente per un numero specifico di
volte o fin quando una condizione specifica non sarà soddisfatta.
Le tue variabili (definite dall'utente) alla pagina 2026
Gli utenti e alcune actions creano variabili definite dall'utente per conservare temporaneamente dei valori.
Use this kind of variable to input values into an action (window title, login credential, or file path) or to
accept the output of an action (values read from a file or a Boolean return).

Utilizzo dell'action Apri per file CSV/TXT
This action enables you to specify the delimiter used in the file, whether to trim the spaces, and the
encoding applied on the file.

Nota:  If there is a double quotation mark (") in the last element of the last line of the CSV/TXT file, at
runtime the bot will encounter an error.

To open a CSV or text file, do the following:
1. Fai doppio clic o trascina l'action Apri dal package CSV/TXT nella tavolozza Azioni.
2. Select any of the following options to specify the location of the CSV or text file to open:

• File Control Room: Enables you to open a file from the .
• File desktop: Enables you to open a file from the device. This field also accepts the file path input

as a string variable or global value.

Nota:  When you enter a file path in the Desktop file field or browse a particular file from the
system, wherein the file path is separated by the \ character and save the , the \ character is
changed to / as the  uses / to separate file paths. Your  continue to run successfully even if the \ is
changed to / during  execution.

• Variabile: Enables you to open a file by specifying a file variable.

3. Se il file contiene una riga di intestazione di cui desideri recuperare i valori, seleziona la casella di
controllo Contiene intestazione.

4. Seleziona una delle seguenti opzioni per specificare il Delimitatore utilizzato nel file:
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• Virgola
• Tabulazione
• Separatore di elenco regionale: Enables you to specify the delimiter as configured in the

regional settings of the Windows operating system. Se il Separatore di elenco nelle impostazioni
regionali di Windows viene modificato, anche il file CSV deve contenere tale carattere come
delimitatore.

• Newline
• Altro: Enables you to specify a delimiter other than the options listed above.

5. Seleziona le caselle di controllo Taglia spazi iniziali e Taglia spazi finali per rimuovere gli spazi
iniziali e finali dai dati estratti dal file CSV/TXT

6. Seleziona un'opzione nell'elenco Codifica per specificare la codifica applicata al file. I dati dal file
CSV/TXT verranno recuperati in base all'opzione di codifica selezionata anche se il file di input ha una
codifica diversa.
• ANSI: Used to encode Latin alphabet.
• UTF8: Can encode all possible characters.
• UNICODE
• Win1251: utilizzato per codificare i linguaggi che utilizzano lo script cirillico, tra cui bulgaro, russo

e serbo.
• UTF-16LE: ignora il carattere Unicode byte order mark (BOM) all'inizio del file.
• Predefinito: identifica la codifica del file. This option supports UTF-8, UTF-16LE, and UTF-16BE

file encoding.

Nota:  Shift-JIS files must use ANSI as encoding to read text file content.

7. Fai clic su Salva.

Utilizza l'action Leggi per recuperare i dati dal file CSV/TXT e assegnarli a una variabile tabella. You can
use the loop action to retrieve each row of data from the file or table variable and assign them to the
record variable for further operations.
• Using Read action alla pagina 1438
• Using the For each row in CSV/TXT iterator alla pagina 1689

Using Read action
Use the Read action to retrieve values from a CSV or TXT file, and insert them into a Table variable to
perform operations with the data values.

Nota:
• The Read action only support CSV/TXT files that conform to the RFC 4180 standard. For more

information about the standard, see Common format and MIME type for CSV files.
• When you use the Read action to read data from a CSV or TXT file that contains double quotes, the

bot might display an error message: Unable to read the file and create a table. We
recommend that you replace all double quotes with an empty or a blank character.

To retrieve values from a CSV or TXT file, do the following:
1. Double-click or drag the Read action from the CSV/TXT node in the Actions palette.
2. Enter the name of the session that you have used to open the CSV or text file in the Open action.
3. Select a Table variable from the Assign value to the variable list.
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Create a variable if it does not already exist. La  mostra un nome descrittivo predefinito della variabile.
If you create several output variables, subsequent variable names are appended with a -1, -2, -3,
and so on to avoid duplication.

Nota:  A bot can return only a maximum of 3 MB to an output variable.
Soluzione: Store the bot output on the device, such as in a .txt file. If the output must be shared
across multiple Bot Runners, store the output in a shared drive.

Perform operations with the values in the Table variable using the Data Table package alla pagina 1439.

Comment package
Use the Comment package to insert a user-specified comment into your bot logic.

Action nel package Comment

Il package Comment include le seguenti action:

Action Descrizione

Commento Inserts a comment.

Nota:  A comment is saved and displayed as a single line. A comment
with multiple lines is displayed as a single line, followed by an ellipsis when
the comment is saved. Comments are ignored when the bot runs.

Data Table package
Il package Data Table contiene actions che consentono di eseguire varie operazioni sui valori delle variabili
tabella. Use these actions to join or merge content, search for specific values, insert rows and columns,
remove duplicate rows, and write values to a file.

Actions nel package Data Table

Il package Data Table include le seguenti actions:

Nota:  If you built a bot using actions from the Data Table package from Build 5322 or earlier, the actions
will be missing when you open the bot with the default package version. You must reinsert the actions and
repopulate the fields.

Action Descrizione

Assegna Assign action alla pagina 1440.

Change column type Change column type action alla pagina 1441.

Elimina il contenuto Clear content action alla pagina 1441.

Elimina colonna Delete column action alla pagina 1441.

Elimina riga Delete row action alla pagina 1442.
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Action Descrizione

Ottieni numero di
colonne

Get number of columns action alla pagina 1442.

Ottieni numero di righe Get number of rows action alla pagina 1442.

Inserisci colonna Insert column action alla pagina 1442.

Inserisci riga Insert row action alla pagina 1443.

Join Using Join action alla pagina 1443.
Utilizza Join type output examples alla pagina 1444 per decidere se
utilizzare l'action Join o Unisci.

Nota:  If you built a bot using this action from package version
2.0.0-20200624-042148 or earlier, the action will be missing when you
open the bot with the default package version. You must reinsert the
action and repopulate the fields.

Unisci Using the Merge action alla pagina 1446.
Use the Merge output example alla pagina 1446 to help you decide
whether to use the Join or Merge action.

Nota:  If you built a bot using this action from package version
2.0.0-20200624-042148 or earlier, the action will be missing when you
open the bot with the default package version. You must reinsert the
action and repopulate the fields.

Rimuovi righe duplicate Remove duplicate rows action alla pagina 1447.

Cerca un valore Search for a value action alla pagina 1448.

Imposta il valore di una
cella singola

Set value of a single cell action alla pagina 1448.

Ordina Sort action alla pagina 1448.

Scrivi su file Using Write to file action alla pagina 1449.

Example:  Example of extracting data from a web table alla pagina 2053

Assign action
The Assign action in the Data Table package enables you to assign values to a table variable.

Impostazioni

You can use this action to manually enter the table data.
• Select whether to create a table with or without values.

• If you select to create a table with values, either manually enter the values or select a source table
variable.

• If you select to create a table without values, specify the number of rows and columns.
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• Select a table variable to hold the output. You can either select the source table variable to overwrite
the values, or select a different table variable.

Change column type action
The Change column type action in the Data Table package enables you to change the data type of a
column.

Impostazioni

• Select the data table name from the drop-down list.
• Scegli se specificare la colonna per Nome o Indice.

• If you select to specify by name, enter the column name.
• If you select to specify by index, enter the column index. Ad esempio, per impostare un valore per la

prima colonna, inserisci 0.

• Select the new column data type from the drop-down list to Number, Boolean, String, or Datetime.
• Se selezioni Data e ora, puoi formattare i valori selezionando un formato predefinito o specificando

un formato personalizzato.
• To specify the format applied on the input data table variable, select an option either from the

predefined format list or enter the value in a custom format.

• Select a table variable to include the output.
You can either select the source table variable to overwrite the values or select a different table
variable.

Clear content action
The Clear content action in the Data Table package enables you to clear the contents of the specified table
variable.

Impostazioni

This action clears the content until the execution of the bot is completed. After the bot execution is
completed, the original values of the table variables are restored.
This action enables you to reuse an existing table variable to store values that are used only during the bot
execution.

Nota:  The data type of the values must be same as the data type of the columns in the table variable.

Delete column action
The Delete column action in the Data Table package enables you to delete a specific column.

Impostazioni

• Select the Table variable name from the drop-down list.
• Specify the column name or column index to delete.
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Nota:  The index count starts from 0.

Delete row action
The Delete row action in the Data Table package enables you to delete a specific row.

Impostazioni

Nota:  Se i valori della tabella dati sono stati letti da un foglio Excel ed è stata selezionata l'opzione Il
foglio contiene un'intestazione nell'action Apri, non è possibile eliminare le celle dalla prima riga.

• Select the Table variable name from the drop-down list.
• Specify the row name or row index to delete.

Nota:  The index count starts at 0.

Get number of columns action
The Get number of columns action in the Data Table package enables you to retrieve the number of
columns from a table.

Impostazioni

Retrieves the number of columns and assigns it to a Number variable. You have the option to select the
non-empty columns or include all the columns in the selection.

Get number of rows action
The Get number of rows action in the Data Table package enables you to retrieve the number of rows from
a table.

Impostazioni

Retrieves the number of rows and assigns it to a Number variable. You have the option to select the non-
empty rows or include all the rows in the selection.

Insert column action
The Insert column action in the Data Table package enables you to insert a column from one table to
another table.

Impostazioni

For destination table:
• Seleziona la variabile tabella di destinazione dall'elenco Inserisci nella tabella dati.
• Select where to insert the column: first index, last index, or enter the column index number.

Nota:  The index count starts at 0.
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For source table:
• Seleziona la variabile tabella sorgente dall'elenco Inserisci dalla tabella.
• Enter the name or index number of the column to insert.

Insert row action
The Insert row action in the Data Table package enables you to insert a row into the table.

Impostazioni

• Nel campo Nome tabella dati, seleziona il nome della variabile tabella dall'elenco a discesa o crea una
nuova variabile di tipo Tabella.

• Select where you want to insert the row: first position, last position, or at a specific index
position.

• Nel campo Nome record riga, crea una variabile record o scegli una variabile record esistente per
contenere i valori della nuova riga che intendi inserire.

• Nella scheda Crea variabile, inserisci il nome della variabile e nella sezione Valore predefinito
inserisci il nome, il valore e il tipo di valore che vuoi aggiungere alla nuova riga secondo i valori di indice
specificati.

Nota:  Il conteggio dell'indice inizia da 0.

Using Join action
Use the Join action to combine content from two table variables. This action enables you to combine
content based on the shared values of a specific column in the tables and store the content into a third
Table variable or one of the two source tables.
To join the content from two Table variables, do the following:
1. Double-click or drag Data table > Join.
2. Select the first Table variable to use from the Enter first data table name list.
3. Enter the name of the column from the first Table variable that contains the data to join.
4. Select the second Table variable to use from the Enter second data table name list.
5. Enter the name of the column from the second Table variable that contains the data to join.
6. Select an option to specify the type of join. Per ulteriori informazioni, consulta Join type output examples

alla pagina 1444.
• inner join: Returns only the records that have matching values in the selected columns in both

tables.
• left outer join: Returns all records from the first table, and the matched records from the second

table.
• right outer join: Returns all records from the second table, and the matched records from the

first table.
• full outer join: Returns all records when there is a match in either left or right table.

7. In the Enter name of data table in which to join field, select the table variable to store the
combined values.

Nota:
• Starting from Automation 360 v.27 if you are using 4.6.0-20220920-155212 version of the Data

Table package, the Enter name of data table in which to join field is mandatory and you must
specify a third data table in the field to save the result of the Join action.
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• When you upgrade from a previous version to Automation 360, and if you have not updated the
package version to 4.6.0-20220920-155212, your bots will continue to run as is. In case you
have updated both your bots and the package to the latest version, your bots will continue to run
successfully if you have selected a table variable to store the output. If the field is empty, then the
bot will encounter an error.

Join type output examples
Select a join type option based on your desired output. Use the examples below to guide your selection.

Inner join

Returns only the records that have matching values in the selected columns in both tables.
For example, if you have a table of employees and their departments, and a table of employees and their
pay rates, this option will return a table of the employees that exist in both tables, and their departments
and pay rates.
Table 1: Employees and Departments

Employee Dipartimento

John 101

Jill 102

Mike 103

Betty 104

Cindy 105

Table 2: Employees and Pay rates

Employee Pay rate

John 50

Betty 50

Mike 40

Jill 35

Dan 45

Table 3: Employees, Departments, and Pay rates

Employee Dipartimento Pay rate

John 101 50

Jill 102 35

Mike 103 40

Betty 104 50
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Left outer join

Returns all records from the first table, and the matched records from the second table.
Using the example Tables 1 and 2, this option returns the following table:
Table 3: Employees, Departments, and Pay rates

Employee Dipartimento Pay rate

John 101 50

Jill 102 35

Mike 103 40

Betty 104 50

Cindy 105

Right outer join

Returns all records from the second table, and the matched records from the first table.
This option returns the following table:
Table 3: Employees, Departments, and Pay rates

Employee Dipartimento Pay rate

John 101 50

Betty 104 50

Mike 103 40

Jill 102 35

Dan 45

Full outer join

Returns all records when there is a match in either left or right table.
This option returns the following table:
Table 3: Employees, Departments, and Pay rates

Employee Dipartimento Pay rate

John 101 50

Jill 102 35

Mike 103 40

Betty 104 50

Cindy 105
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Employee Dipartimento Pay rate

Dan 45

Using the Merge action
Use the Merge action to combine the contents of two tables when both source tables contain identical
column headers. To combine tables that contain different column headers, use the Join action.
If one of the tables contains non-identical headers, then the merged table will contain the columns from
the first source table with data from the second source table under the identical column headers, followed
by the non-identical columns and data from the second source table.
To merge the content, perform these steps:
1. Double-click or drag Data table > Merge.
2. Select the first table variable you want to use from the Enter first data table name list.
3. Select the second table variable you want to use from the Enter second data table name list.
4. Select the table variable that you want to use to store the merged data from the Enter name of data

table in which to merge list.
5. Fai clic su Salva.

Per ulteriori informazioni, consulta Merge output example alla pagina 1446.

Merge output example
The Merge action combines data from two tables with identical column headers, and stores the merged
content in a third table or one of the two source tables. These examples demonstrate the output of two
tables with identical column headers and the output of two tables with differing column headers.

Output of tables with identical column headers

For example, if you have a table of employees hired in September and a table of employees that were
hired in October, this option will return a table of all the employees, with the October hires merged below
the September hires.
Table 1: Employees hired in September

Employee Dipartimento Pay rate

John 101 50

Jill 102 35

Table 2: Employees hired in October

Employee Dipartimento Pay rate

Mike 103 40

Betty 104 50

Table 3: All employees

Nota:  The column headers in the output table are always lowercase.
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employee department pay rate

John 101 50

Jill 102 35

Mike 103 40

Betty 104 50

Output of tables with differing column headers

In this example, the second table has a different column header. As a result, the third table contains the
columns from the first source table with data from the second source table under the identical column
headers, followed by the non-identical columns and data from the second source table.
Table 1: Employees hired in September

Employee Dipartimento Pay rate

John 101 50

Jill 102 35

Table 2: Employees hired in October

Employee Dipartimento Salary

Mike 103 40

Betty 104 50

Table 3: All employees

employee department pay rate salary

John 101 50

Jill 102 35

Mike 103 40

Betty 104 50

Remove duplicate rows action
The Remove duplicate rows action in the Data Table package enables you to delete any duplicate rows
from a table.

Impostazioni

Select the Table variable name from the drop-down list.
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Search for a value action
The Search for a value action in the Data Table package enables you to search for a specific value in a
table and returns the row or column numbers in which the entry occurs and assigns the values to a List
variable.

Impostazioni

For example, if you search for the entry
abc

that is available at the fourth row and third column of a table variable, the action returns
3,2

as output. As the index number for the row and column starts with zero, the values in the output indicates
the fourth row and third column.
• Select the Table variable name from the drop-down list.
• Enter the text to search for.
• Select Match case to ensure the case matches the text searched.

When you search for a value using the Search for a value action, it will either return:
• A list of all the positions from the Data table where the search matched, or
• An empty list if the value is not found.

Set value of a single cell action
The Set value of a single cell action in the Data Table package enables you to update the value of a
specific cell.

Impostazioni

• Select the Table variable name from the drop-down list.
• Enter the row index. Ad esempio, per impostare un valore per la prima riga, inserisci 0.
• Scegli se specificare la colonna per Nome o Indice.

• If you select to specify by name, enter the column name. Capitalization is not important.
• If you select to specify by index, enter the column index. Ad esempio, per impostare un valore per la

prima colonna, inserisci 0.

• Inserisci il valore da impostare.

Sort action
The Sort action in the Data Table package enables you to sort the table data by column.

Impostazioni

This action enables you to sort the data by column data format (string, number, datetime, or Boolean).
• Select the Table variable name from the drop-down list.
• Specify the column name or column index to sort by.
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• Select the order in which to sort: ascending order or descending order.

Nota:  If you built a  using this  from  version 2.0.0-20200624-042148 or earlier, the  will be missing when
you open the  with the default  version. You must reinsert the  and repopulate the fields.

Using Write to file action
Utilizza l'azione Scrivi su file per scrivere i dati da una variabile di tipo tabella a un file CSV o TXT.
To write data into a file, do the following:
1. Fai doppio clic o trascina Tabella dati > Scrivi su file.
2. Seleziona la variabile Tabella che contiene i dati da scrivere dall'elenco Nome tabella dati.
3. Specifica la posizione del file in cui scrivere i dati nel campo Immetti nome file.
4. Seleziona la casella di controllo Crea cartelle/file se non esistono per creare il file o la cartella

specificati nel campo Immetti nome file.
5. Select an option to specify what to do when writing data in an existing file:

• Aggiungi a file esistente
• Sostituisci file esistente

6. Seleziona un'opzione dall'elenco Delimitatore di riga per specificare il delimitatore da utilizzare per
le righe.

7. Seleziona un'opzione dall'elenco Delimitatore di colonna per specificare il delimitatore da utilizzare
per le colonne.

8. Seleziona un'opzione nell'elenco Codifica per specificare la codifica che desideri applicare al file.
The default encoding is set to ANSI
• ANSI
• UTF-8
• Unicode
• Win1251
• UTF-8 con BOM
• UTF-16LE
• Maiusc-JIS (codifica giapponese)

9. In the Assign value to variable list, select a string variable.

Database package
I database supportano le operazioni interne di un'azienda mediante la memorizzazione di una varietà di
dati, quali transazioni di vendita, cataloghi dei prodotti, inventari e profili dei clienti. Use the Database
package to connect to a database, begin a transaction, and manipulate the stored data by retrieving,
inserting, updating, deleting, and exporting it to a CSV file.

Prima di iniziare

Esegui le seguenti actions contenute nel package Database come parte integrante dell'utilizzo del set di
actions disponibili:
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Nota:  When you use actions such as Read from, Run stored procedure, or Export to data table to
retrieve records from a MS SQL Server table which has a bit type column or an Excel column (with TRUE or
FALSE values), then the retrieved data will be referred to 0 and 1, not TRUE and FALSE.

1. Stabilisci una connessione con un server di database utilizzando l'action Connetti.
Consulta Utilizzo dell'action Connetti per il database alla pagina 1451.

2. Scegli tra le seguenti:
• Utilizza l'action Leggi da per recuperare i record dal database. Consulta Using the Read from action

alla pagina 1457.
• Se stai automatizzando un'attività che comporta l'esecuzione di modifiche al database, inserisci

l'action Avvia transazione database seguita dalle actions che automatizzano le modifiche.
Questa action garantisce che tutti i record vengano aggiornati o eliminati nella loro interezza e
impedisce aggiornamenti o eliminazioni accidentali di dati incompleti, se il bot rileva un errore
durante la fase di esecuzione.

3. Se hai utilizzato l'action Avvia transazione database in questa sessione, inserisci Termina
transazione database per apportare le modifiche.

4. Ogni set di actions del database termina con l'action Disconnetti per terminare la connessione al
server di database.

Actions nel package Database

Il package Database include le seguenti actions:

Action Descrizione

Inizia transazione del
database

Consulta Begin database transaction action alla pagina 1451.

Termina transazione
del database

Consulta End database transaction action alla pagina 1451.

Connetti Consulta Utilizzo dell'action Connetti per il database alla pagina 1451.
Il database Snowflake che utilizza il driver ODBC è supportato.

Disconnetti Consulta action Disconnetti alla pagina 1457.

Leggi da Consulta Using the Read from action alla pagina 1457.
Il database Snowflake che utilizza il driver ODBC è supportato.

Esegui procedure
archiviate

Consulta Using the Run stored procedure action alla pagina 1458.

Esporta in tabella dati Consulta Using the Export to data table action alla pagina 1462.
Il database Snowflake che utilizza il driver ODBC è supportato.

Gestisci le procedure
archiviate

Consulta Manage stored procedure action alla pagina 1463.

Inserisci/aggiorna/
elimina

Consulta Insert/Update/Delete action alla pagina 1463.
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Riferimenti correlati
Loop package alla pagina 1681
Utilizza il Loop Pacchetto per eseguire una sequenza di actions ripetutamente per un numero specifico di
volte o fin quando una condizione specifica non sarà soddisfatta.
Variables overview alla pagina 2022
Automation 360 offers a variety of variables, each designed to hold specific types of data and is intended
for specific use. Use the topics below to learn more about each variable and how to use them.

Begin database transaction action
Use the Begin database transaction action in the Database package to starts a database transaction to
commit all database actions till the end database transaction.

Impostazioni

• Le actions inserite tra le actions Avvia transazione database e Termina transazione database
vengono trattate come una singola unità. Per poter aggiornare il database, il bot deve eseguire
correttamente tutte le actions. Questo impedisce una voce parziale nel caso in cui una delle actions
abbia esito negativo.
Ad esempio, nella contabilità a doppia voce ogni addebito richiede la registrazione di un credito. Se
un'azienda riceve 5.000 dollari di prodotti, il contabile deve addebitare 5.000 dollari all'inventario e
accreditare 5.000 dollari alla contabilità fornitori.

• Inserisci le actions che registrano queste voci tra le actions Avvia transazioni database e Termina
transazione database per assicurarti che entrambe le voci siano registrate o che nessuna delle due
sia registrata nel database.

• In the Session name field, enter the name of the session that you used to connect to the database
server in the Connect action.

Nota:  Begin and End database transaction actions do not support ODBC connectivity.

End database transaction action
Use the End database transaction action Database package to commits all the database operations that
were performed with the actions that followed the Begin database transaction action.

Impostazioni

• All the database operations that were performed with the actions that followed the Begin database
transaction action are committed, under the condition that the bot successfully ran those actions.

• In the Session name field, enter the name of the session that you used to connect to the database
server in the Connect action.

Nota:  Begin and End database transaction actions do not support ODBC connectivity.

Utilizzo dell'action Connetti per il database
Utilizza l'action Connetti per stabilire una connessione con il server di database che desideri utilizzare
per automatizzare le attività correlate ai database. Questa action supporta i server di database Microsoft
Access, Microsoft SQL Server, MySQL, Oracle, PostgreSQL Server e SQLite, nonché l'uso di file CSV,
Microsoft Excel e TXT come database.

Nota:  If your current office installation is any of the following:
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• Microsoft 365 Apps for Enterprise
• Office 2016, 2019, or 2021 (Consumer Version 2009 or later)

Then you do not need to install the Microsoft Access Database Engine as an additional component in your
system.
However, if you have both Microsoft 365 Apps and the Microsoft Access Database Engine are installed on
your system, then you can uninstall the Microsoft Access Database Engine and repair Microsoft 365 Apps.
Microsoft recommends that you do not install the Microsoft Access Database Engine driver separately
because both the Microsoft Access Database Engine 2016 and Microsoft 365 Apps use the same major
version identifier (16.0). To learn more about the Microsoft Access Database Engine driver installation
requirement, see Unable to use the Access ODBC or OLEDB provider

Specifica i dettagli di un server di database e associalo a un nome di sessione. Utilizza il nome sessione
fornito in questa action nelle altre actions, per non dover fornire di nuovo i dettagli del server di database
in tali actions.
Per stabilire una connessione con un server di database, procedi come segue:
1. Fai doppio clic o trascina l'action Connetti dal package Database nella tavolozza Azioni.
2. Inserisci un nome univoco per la sessione nel campo Nome sessione.
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3. Seleziona l'opzione di connessione Predefinita o Definita dall'utente.
When you select User defined connection mode and use actionRead from with encoding ANSI to
save the retrieved data in a CSV file, you will see that the retrieved records from the Oracle database
display garbled character.
To know more about this issue, see Fullwidth hyphen is garbled when exporting data to csv by Database:
Read from action with encoding ANSI (A-people login required)

• Se selezioni l'opzione Predefinita, puoi immettere direttamente la stringa di connessione per
qualsiasi tipo di database supportato.
Se hai configurato il tuo database e l'archivio condiviso nel sito secondario, utilizza la connessione
JDBC per connetterti al database di replica. Ad esempio, jdbc:sqlserver://AGL-
ADDRESS:1433;databaseName=DB_NAME;user=username;password=password;applicationIntent=ReadOnly

È possibile stabilire una connessione con il database Snowflake utilizzando i driver ODBC. Per
ulteriori informazioni sul download del driver ODBC, consulta Snowflake using ODBC Driver

Puoi inserire la stringa di connessione per connetterti al database. Ad esempio,
Driver={SnowflakeDSIIDriver};Server={account}.aws.snowflakecomputing.com;Database=DB_NAME;uid=username;pwd=password;

Utilizza questa opzione per connetterti a un file Excel, CSV o TXT. Consulta Connection Strings by
database type.

Nota:  Per accedere a qualsiasi database tramite ODBC, devi installare un driver ODBC a 32 bit sul
dispositivo.

Per garantire un'automazione più sicura, utilizza una variabile di Credential Vault per la stringa di
connessione.

• Select the Use ODBC 64-bit driver for connection option to connect to the database.

Nota:
• Ensure that 64-bit access ODBC driver is installed on your system to access any database and

perform operations by using database actions.
• The following action does not support the 32-bit or 64-bit OBDC drivers because the listed

actions are for database transactions that are carried out after making a connection with the
database:
• Begin database transaction
• End database transaction
• Manage stored procedure

• Using Excel as a database, you can process more rows with 64-bit drivers compared to 32-bit
ones.

• Se selezioni l'opzione Definita dall'utente, puoi selezionare il tipo di database dalle opzioni
disponibili e completare i campi che seguono a seconda della scelta fatta:
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Tipo di database Opzioni

Microsoft SQL Server,
PostgreSQL Server

• Nome server: immetti il nome del server di
database a cui desideri connetterti.

• Nome database: immetti il nome del
database.

• Nome utente: immetti il nome utente che
desideri utilizzare per accedere al server di
database. Per garantire un nome utente sicuro,
seleziona una variabile di Credential Vault. In
alternativa immetti un valore.

• Password: immetti la password per il nome
utente fornito. Per garantire una password
sicura, seleziona una variabile di Credential
Vault. In alternativa immetti un valore.

• Nome istanza: immetti un nome per questa
istanza di connessione.

Connessione a un Microsoft SQL Server con
l'autenticazione Windows alla pagina 1456

MySQL Immetti le stesse opzioni del tipo di database
Microsoft SQL Server. Inserisci anche il numero
della porta. Il numero della porta predefinita è
3306.

Microsoft Access, SQLite Seleziona il percorso del file del database da:
• Cartella Bot
• dispositivo locale
• variabile di file esistente
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Tipo di database Opzioni

Oracle • Server name (Optional): immetti il nome del
server Oracle a cui desideri connetterti.

• Optional:Select an option to specify the Oracle
instance you want to use:
• ID sistema (SID): immetti l'ID del

sistema.
• Nome servizio: Immetti il nome del

servizio.
• Nome TNS: Immetti il Nome TNS

disponibile nel file di configurazione
tnsname.ora.
Specifica il percorso del file di
configurazione tnsname.ora se non hai
impostato la proprietà di sistema con la
variabile ambiente.

Nota:  You can connect to the Oracle Database
with the Server name or Oracle instance. If
you are connecting using the server name, you
must specify the System id (SID) or Service
name in the Oracle instance field to identify
the Oracle database and its instance. However,
if you are connecting using the TNS name,
you do not require to enter any value in the
Server name field. You should only enter the
value of the TNS name and file path.

• Nome utente: immetti il nome utente che
desideri utilizzare per accedere al server
Oracle. Per garantire un nome utente sicuro,
seleziona una variabile di Credential Vault. In
alternativa immetti un valore.

• Password: immetti la password per il nome
utente fornito. Per garantire una password
sicura, seleziona una variabile di Credential
Vault. In alternativa immetti un valore.

• Porta: immetti il numero della porta. Il numero
della porta predefinita è 1521.

Nota:  Se stabilisci una connessione utilizzando un driver JDBC, per Microsoft SQL Server, il
package Databaseinclude già il driver JDBC. Tuttavia, per altri server di database, devi fornire il file
jar del driver JDBC corrispondente dopo averlo scaricato dalle risorse appropriate.
Se stabilisci una connessione utilizzando un driver ODBC, non è necessario fornire un file jar.

4. Seleziona un file driver dalla cartella Bot, dal dispositivo locale o da una variabile file.
5. Fai clic su Salva.

Scegli tra le seguenti:
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• Utilizza l'action Leggi da per recuperare i record dal database.
Using the Read from action alla pagina 1457

• Se stai automatizzando un'attività che comporta l'esecuzione di modifiche al database, inserisci l'action
Avvia transazione database.
Questa action garantisce che tutti i record vengano aggiornati o eliminati nella loro interezza e
impedisce aggiornamenti o eliminazioni accidentali di dati incompleti, se il bot rileva un errore durante
la fase di esecuzione.
Database package alla pagina 1449

Connessione a un Microsoft SQL Server con l'autenticazione Windows
Configura il dispositivo e Connettiti action da Database package per automatizzare la connessione a un
Microsoft SQL Server con l'autenticazione Windows NT.
Questa attività è applicabile solo per le versioni precedenti alla Build 9664. A partire da Build 9664, non è
più necessario aggiungere manualmente i file DLL per connettersi a un Microsoft SQL Server.
Per utilizzare l'autenticazione di Windows NT per la connessione al Microsoft SQL Server, esegui i seguenti
passaggi:
1. Scarica il driver JDBC per Microsoft SQL Server.

Download the JDBC Driver from Microsoft

2. Nella cartella decompressa, individua il file .dll nel percorso del file auth\x64\.
3. Se il file .dll ha un nome diverso, rinominalo sqljdbc_auth.dll.
4. Sui dispositivi Bot Creator o Bot Runner, copia il file sqljdbc_auth.dll in uno dei seguenti

percorsi, a seconda di dove hai installato Bot Agent e dell'opzione che hai selezionato al momento
dell'installazione:

Nota:  Se stai utilizzando la Build 9664 o superiore, non devi copiare il file nella posizione in cui è
stato installato Bot Agent.

• Se hai installato Bot Agent a livello utente e hai selezionato l'opzione Solo per me (nome
utente), copia in C:\Users\User Name\AppData\Local\Programs\Automation
 Anywhere\Bot Agent\jre\bin.

• Se hai installato Bot Agent a livello di sistema e hai selezionato l'opzione Chiunque usi questo
computer (tutti gli utenti), copia in C:\Program Files\Automation Anywhere\Bot
 Agent\jre\bin.

Questo abilita l'autenticazione di Windows, perché il driver JDBC non può eseguire tale operazione per
impostazione predefinita.

5. Seleziona l'opzione di connessione Predefinita.
6. Immetti la stringa di connessione: jdbc:sqlserver://

localhost;databaseName=Test;integratedSecurity=true;

7. Fai clic su Salva.

Scegli tra le seguenti:
• Utilizza l'action Leggi da per recuperare i record dal database.

Using the Read from action alla pagina 1457
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• Se stai automatizzando un'attività che comporta l'esecuzione di modifiche al database, inserisci l'action
Avvia transazione database.
Questa action garantisce che tutti i record vengano aggiornati o eliminati nella loro interezza e
impedisce aggiornamenti o eliminazioni accidentali di dati incompleti, se il bot rileva un errore durante
la fase di esecuzione.
Database package alla pagina 1449

action Disconnetti
Use the Disconnect action in the Database package to disconnect from a database.

Impostazioni

In the Session name field, enter the name of the session that you used to connect to the database server
in the Connect action.
A record set is returned when you run a stored procedure or a query. To use the record set stored in the
memory even if the session is disconnected, select Keep database schema in cache until bot finishes
running. By using this option, you can enable the Loop action to iterate the record set by using cached
schema after disconnecting from the database.
Il database Snowflake che utilizza il driver ODBC è supportato.

Using the Read from action
Use the Read from action to retrieve records from the database and save the retrieved data in a CSV file.
This action enables you to retrieve up to one million records from the database.
To automate the task of selecting and saving a set of records, follow these steps:
1. Enter the name of the session you used to connect to the database server in the Connect action.

You do not have to provide the details of the database server here because you have already
associated those details with the session name when using the Connect action.

2. Enter the SELECT statement to specify the column and table names.
This field supports SQL syntax. For example, SELECT CustomerName,City FROM Customers

Nota:  CTE (Common Table Expression) is supported using WITH keyword in the SQL compliant
databases such as Oracle and MySQL. Ad esempio,

WITH customers_in_usa AS (SELECT CustomerName, state FROM customers WHERE
 country = 'USA') 
SELECT cName FROM customers_in_usa WHERE state = 'LA' ORDER BY
 CustomerName

3. Enter the maximum number of records to retrieve.
4. Opzionale: Enter a timeout value.

When the specified time expires, the statement execution stops even if the execution is not
completed.

5. Select the Export data to CSV option to save the retrieved data.
a) Select the file path from the Bots folder, the local device, or an existing file variable.
b) Select the CSV file encoding to be either ANSI, UNICODE, or UTF8.
c) Select whether to export the CSV file with or without the column headers.

With column headers
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CustomerName City

Manny Pittsburgh

Kate Los Angeles

John Boston

Without column headers

Manny Pittsburgh

Kate Los Angeles

John Boston

d) Select this check box if you do not want a CSV file to be created when the SQL query does not
return any data.

e) Specify whether to overwrite the file or append the data to the existing file if a CSV file with the
same name exists.

6. Fai clic su Salva.

Using the Run stored procedure action
Stored procedures are a set of SQL statements that are created and stored in the database. These SQL
statements might be complex and have to run multiple times. Use the Run stored procedure action to
execute existing stored procedures.

Nota:
• This action does not support Microsoft Access or SQLite database types.
• Starting from Automation 360 v.22 (Build 10526), for stored procedures, the limit of 32 characters for

input and output parameters has been removed.

To automate the task of executing a stored procedure, follow these steps:
1. Enter the name of the session you used to connect to the database server in the Connect action.

You do not have to provide the details of the database server here because you have already
associated those details with the session name when using the Connect action.

2. Enter the name of the stored procedure.
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3. Opzionale: Click Add parameter to provide an input parameter or configure an output parameter.
Select from the following parameter options:
Opzione Fasi

Inserisci Parameter is passed from the bot to the stored procedure.
• Name: Enter the name of the parameter from the stored procedure.
• Value (optional): Enter a value or select a variable.
• Tipo: Select the data type from the following options

• BIGINT (number)
• BINARY (Boolean)
• BIT (number)
• CHAR (string)
• DATE (date time)

Supported format yyyy-mm-dd
• DECIMAL (number)
• DOUBLE (number)

Default choice for decimal values.
• FLOAT (number)
• INTEGER (number)

Uses 4 bytes to store an integer with a value from -2,147,483,648 to
2,147,483,647

• LONGVARBINARY (Boolean)
• LONGVARCHAR (string)
• NUMERIC (number)
• REAL (number)
• SMALLINT (number)

Uses 2 bytes to store an integer with a value from -32,768 to 32,767
• TIME (date time)

Supported format hh:mm:ss
• TIMESTAMP (date time)

Supported format yyyy-mm-dd hh:mm:ss.f, where f is fractional
seconds

• TINYINT (number)
Uses 1 byte to store an integer with a value from 0 to 255

• VARBINARY (Boolean)
• VARCHAR (string)

For example, if running the example function from the Manage stored
procedure action, configure the following two input parameters and values
for the sum_of_two function to add:
• Parameter 1: num1, 5, TINYINT
• Parameter 2: num2, 10, TINYINT
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Opzione Fasi

Output Parameter is passed from the stored procedure to the bot.
• Name: Enter the name of the parameter from the stored procedure.
• Tipo: Select the data type from the following options

• BIGINT (number)
• BINARY (Boolean)
• BIT (number)
• CHAR (string)
• DATE (date time)

Supported format yyyy-mm-dd
• DECIMAL (number)
• DOUBLE (number)

Default choice for decimal values.
• FLOAT (number)
• INTEGER (number)

Uses 4 bytes to store an integer with a value from -2,147,483,648 to
2,147,483,647

• LONGVARBINARY (Boolean)
• LONGVARCHAR (string)
• NUMERIC (number)
• REAL (number)
• SMALLINT (number)

Uses 2 bytes to store an integer with a value from -32,768 to 32,767
• TIME (date time)

Supported format hh:mm:ss
• TIMESTAMP (date time)

Supported format yyyy-mm-dd hh:mm:ss.f, where f is fractional
seconds

• TINYINT (number)
Uses 1 byte to store an integer with a value from 0 to 255

• VARBINARY (Boolean)
• VARCHAR (string)

When the bot runs, the action converts the database data type to an
Automation 360-supported data type.
For example, if running the example sum_of_two function from the
Manage stored procedure action, configure the output parameter: sum,
TINYINT.
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Opzione Fasi

Input/Output Parameter can be used for both input and output.
• Name: Enter the name of the parameter from the stored procedure.
• Value (optional): Enter a value or select a variable.
• Tipo: Select the data type from the following options

• BIGINT (number)
• BINARY (Boolean)
• BIT (number)
• CHAR (string)
• DATE (date time)

Supported format yyyy-mm-dd
• DECIMAL (number)
• DOUBLE (number)

Default choice for decimal values.
• FLOAT (number)
• INTEGER (number)

Uses 4 bytes to store an integer with a value from -2,147,483,648 to
2,147,483,647

• LONGVARBINARY (Boolean)
• LONGVARCHAR (string)
• NUMERIC (number)
• REAL (number)
• SMALLINT (number)

Uses 2 bytes to store an integer with a value from -32,768 to 32,767
• TIME (date time)

Supported format hh:mm:ss
• TIMESTAMP (date time)

Supported format yyyy-mm-dd hh:mm:ss.f, where f is fractional
seconds

• TINYINT (number)
Uses 1 byte to store an integer with a value from 0 to 255

• VARBINARY (Boolean)
• VARCHAR (string)

4. Enter the maximum number of records to retrieve.
You can limit the results of the execution.

5. Opzionale: Enter a timeout value.
When the specified time expires, the statement execution stops even if the execution is not
completed.
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6. Opzionale: Select the Export data to CSV option to save the retrieved data.

Nota:  The Export data to CSV option does not support Oracle Database or PostgreSQL Server
database types. Use output parameters to retrieve values.

a) Select the file path from the Bots folder, the local device, or an existing file variable.
b) Select the CSV file encoding to be either ANSI, UNICODE, or UTF8.
c) Select whether to export the CSV file with or without the column headers.

With column headers

CustomerName City

Manny Pittsburgh

Kate Los Angeles

John Boston

Without column headers

Manny Pittsburgh

Kate Los Angeles

John Boston

d) Specify whether to overwrite the file or append the data to the existing file if a CSV file with the
same name exists.

7. Opzionale: Select a dictionary variable to hold the output if the stored procedure returns a value.
Each output parameter name is a dictionary key which holds the corresponding parameter value.
For example, if you assign the sum_of_two function output to $Output$, when the bot calls
$Output{sum}$, the variable returns 15.

Nota:  If you do not know the output parameter name, use the default key Output appended by the
parameter index number.

8. Fai clic su Salva.

Using the Export to data table action
Use the Export to data table action to retrieve records from the database and store the retrieved data in
a table variable.
To automate the task of selecting and saving a set of records, follow these steps:
1. Enter the name of the session you used to connect to the database server in the Connect action.

You do not have to provide the details of the database server here because you have already
associated those details with the session name when using the Connect action.

2. Enter the SELECT statement to specify the column and table names.
This field supports SQL syntax. For example, SELECT CustomerName,City FROM Customers

Nota:  CTE (Common Table Expression) is supported using WITH keyword in the SQL compliant
databases. For example, WITH customers_in_usa AS (SELECT CustomerName, state FROM
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 customers WHERE country = 'USA') SELECT cName FROM customers_in_usa WHERE
 state = 'LA' ORDER BY CustomerName

3. Enter the maximum number of records to retrieve.
4. Opzionale: Enter a timeout value.

When the specified time expires, the statement execution stops even if the execution is not
completed.

5. In the Assign to option, select the table variable to store the retrieved data.
6. Fai clic su Salva.

Manage stored procedure action
Use the Manage stored procedure action in the Database package to create, update, and delete a stored
procedure within the specified database. Una procedure archiviata rappresenta il codice SQL salvato nel
database, che consente di eseguirlo ripetutamente.

Impostazioni

• In the Session name field, enter the name of the session that you used to connect to the database
server in the Connect action.

• Nel campo Inserisci comando completo, immetti il comando per creare, aggiornare o eliminare la
stored procedure. Puoi specificare i parametri di input e output per il comando; fornisci valori o variabili
che contengono i valori nell'action Esegui stored procedure.

Nota:  Dichiara un delimitatore e utilizzalo per chiudere l'istruzione SQL.

Esempio di MySQL: In questo esempio, il bot verifica se nel database è presente una procedura
denominata sum_of_two. In caso contrario, il bot crea una procedura che accetta due parametri di
input (num1 e num2), li aggiunge insieme e produce la somma come parametro di output:

 DROP PROCEDURE IF EXISTS sum_of_two;
    DELIMITER $$
        CREATE PROCEDURE sum_of_two(IN num1 INT,IN num2 INT,OUT sum INT)
        BEGIN
            SET sum := num1 + num2;
    END
    $$

• Nel campo Timeout della query in secondi, specifica il tempo entro il quale l'esecuzione
dell'istruzione deve arrestarsi, anche se l'esecuzione non è completata.

Insert/Update/Delete action
Use the Insert/Update/Delete action in the Database package to execute an INSERT, UPDATE, or DELETE
statement from the database.

Impostazioni

• In the Session name field, enter the name of the session that you used to connect to the database
server in the Connect action.
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• Nel campo Istruzione, immetti l'istruzione SQL per inserire, aggiornare o eliminare i record.
• Utilizza un'istruzione INSERISCI per creare nuovi record in una tabella:

INSERT INTO table_name (column1, column2, column3, ...)
VALUES (value1, value2, value3, ...)

• Utilizza un'istruzione AGGIORNA per modificare un record:

UPDATE table_name
SET column1 = value1, column2 = value2, ...
WHERE condition

• Utilizza un'istruzione ELIMINA per rimuovere un record:

DELETE FROM table_name WHERE condition
Example: DELETE FROM Persons WHERE LastName='Smith'

• Nel campo Timeout della query in secondi, specifica il tempo entro il quale l'esecuzione
dell'istruzione deve arrestarsi, anche se l'esecuzione non è completata.

Esempio di migrazione dei dati da Excel a un database
In questo esempio, viene creato un bot per trasferire i valori da un foglio di calcolo Excel a un database
utilizzando actions da packages Database, Excel advanced e Loop.
Prima di iniziare a generare il tuo bot, crea quanto segue:
• Crea un foglio di calcolo Excel con i seguenti valori e salvalo (ad esempio: Test_migration_db.xlsx)

John Williams jwilliams@cmail.com

Sam Li sam.li@xyz.org

Carl Miller carl@carlmillerllc.com
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• Accedi alla tabella del database denominata CustomerT con le seguenti colonne: (Crea un database
simile all'immagine sottostante e salvalo - ad esempio: salvalo come Test_Migration_db.accdb)
• Nome
• Cognome
• E-mail

Per eseguire la migrazione dei valori da un foglio di calcolo a una tabella in un database, attieniti alla
seguente procedura:
1. Create a new bot:

a) Nel pannello di sinistra, fai clic su Automazione.
b) Fai clic su Crea nuovo > Bot.
c) In the Create Task Bot window, enter the bot name.
d) Accept the default folder location: \Bots\

To change the default bot storage location, click Choose and follow the prompts.
e) Fai clic su Crea e modifica.
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2. Apri il foglio di calcolo:
a) Fai doppio clic o trascina the l'action Excel avanzato > Apri.
b) Fai clic su Sfoglia per specificare il percorso del file.

c) Seleziona l'opzione per aprire il file in lettura-scrittura.
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3. Esegui la connessione al database:
a) Fai doppio clic o trascina l'action Database > Connetti.
b) Seleziona la modalità di connessione definita dall'utente.

c) Seleziona il tipo di database Microsoft Access.
d) Fai clic su Sfoglia per specificare il percorso del file.
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4. Inserisci i valori Excel nel database, riga per riga:
a) Fai doppio clic o trascina l'action Loop.
b) Seleziona l'iteratore Excel avanzato > Per ogni riga nel foglio di lavoro.
c) Seleziona Tutte le righe dal menu a discesa Loop tramite.

d) In Assegna il valore corrente a questa variabile, crea la variabile record rExcelCurrentRow.
e) Trascina l'action Database > Inserisci/aggiorna/elimina nel container Loop.
f) Immetti la seguente istruzione SQL:

INSERT INTO CustomerT (FirstName,LastName,Email) values
 ('$rExcelCurrentRow[0]$','$rExcelCurrentRow[1]$','$rExcelCurrentRow[2]$');
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5. Esegui la disconnessione dal database. Trascina l'action Database > Disconnetti sotto al container
Loop.

6. Chiudi il foglio di calcolo. Fai doppio clic o trascina l'action Excel avanzato > Chiudi foglio di
calcolo.

7. Fai clic su Salva.

Riferimenti correlati
Database package alla pagina 1449
I database supportano le operazioni interne di un'azienda mediante la memorizzazione di una varietà di
dati, quali transazioni di vendita, cataloghi dei prodotti, inventari e profili dei clienti. Use the Database
package to connect to a database, begin a transaction, and manipulate the stored data by retrieving,
inserting, updating, deleting, and exporting it to a CSV file.
Excel advanced package alla pagina 1533
Il package Excel advanced contiene actions che consentono di automatizzare molte delle attività ripetitive
quando si lavora con i fogli di calcolo di Microsoft Excel.
Loop package alla pagina 1681
Utilizza il Loop Pacchetto per eseguire una sequenza di actions ripetutamente per un numero specifico di
volte o fin quando una condizione specifica non sarà soddisfatta.
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Database server support matrix
Refer to the list of databases supported in Automation 360
Following is the list of supported database server with JDBC connectivity.

Database
action

MS SQL
server

Accesso
MS

PostgreSQL
Server

My SQL Excel Testo CSV Oracle AWS
RDS

Microsoft
Azure

Connetti Y Y Y Y N N N Y Y Y

DisconnettiY Y Y Y N N N Y Y Y

Leggi
da

Y Y Y Y N N N Y Y Y

Esegui
procedure
archiviate

Y n/d Y Y n/d n/d n/d Y Y Y

Esporta
in
tabella
dati

Y Y Y Y N N N Y Y Y

Managed
stored
procedure

Y n/d Y Y n/d n/d n/d Y Y Y

Insert/
Update /
Delete

Y Y Y Y N N N Y Y Y

Inizia
transazione
del
database

Y n/d Y Y n/d n/d n/d Y Y Y

Termina
transazione
del
database

Y n/d Y Y n/d n/d n/d Y Y Y

Following is the list of supported database server with ODBC connectivity.

Database
action

MS
SQL
server

Accesso
MS

PostgreSQL
Server

My
SQL

Excel Testo CSV SnowflakeOracle AWS
RDS

Microsoft
Azure

ConnettiY Y Y Y Y Y Y Y Y Y Y

DisconnettiY Y Y Y Y Y Y Y Y Y Y

Leggi
da

Y Y Y Y Y Y Y Y Y Y Y

Esegui
procedure
archiviate

Y n/d Y Y n/d n/d n/d n/d Y Y Y
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Database
action

MS
SQL
server

Accesso
MS

PostgreSQL
Server

My
SQL

Excel Testo CSV SnowflakeOracle AWS
RDS

Microsoft
Azure

Esporta
in
tabella
dati

Y Y Y Y N N N - Y Y Y

Managed
stored
procedure

N n/d N N n/d n/d n/d n/d N N N

Insert/
Update /
Delete

Y Y Y Y Y Y Y Y Y Y Y

Inizia
transazione
del
database

N n/d N N n/d n/d n/d N N N N

Termina
transazione
del
database

N n/d N N n/d n/d n/d N N N N

• Y: Supported
• N: Not supported
• n/a: Non applicabile

Datetime package
Un valore data/ora consiste in una data, un'ora e un fuso orario. RPA Workspace stores datetime values
in a Datetime variable. The Datetime package contains actions that enable you to perform various
operations on datetime values. You can use these actions to manipulate and compare values in the
Datetime variables.

Actions in the Datetime package

You can enter either a String or a Global variable for any of the actions in the Datetime package. The
actions then assign the output to a variable.
Le actions nel package Data e ora accettano una variabile come input e assegnano l'output a una
variabile. These actions enable you to compare two Datetime values, add to or subtract from a Datetime
value, and convert a Datetime value to a string value.
Il package Data e ora include le seguenti actions:

Action Descrizione

Aggiungi Consulta Using the Add action alla pagina 1472.

Assegna Consulta Utilizzo dell'azione Assegna alla pagina
1473.
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Action Descrizione

È dopo Consulta Is after action in Datetime alla pagina
1473.

È prima Consulta Is before action in Datetime alla pagina
1474.

È uguale Consulta Is equal action in Datetime alla pagina
1474.

Sottrai Consulta Using the Subtract action alla pagina
1474.

To string Consulta Using the To string action alla pagina
1475.

Riferimenti correlati
Datetime formats alla pagina 1475
Specify a custom format when you convert a datetime value to a string value by using the predefined
formats available in RPA Workspace.

Using the Add action
Use the Add action to increase the value in the Datetime variable by a specified time value and unit. For
example, you can use this action to increase the Datetime variable value by three hours or by three days.

To add a value to a Datetime variable, do the following:
1. Double-click or drag the Add action from the Datetime node in the Actions palette.
2. Select an option from the Source date and time variable list to specify the variable that contains

the value to which you want to add the time unit.
3. Enter the value you want to add in the Time value to add field.
4. Select an option from the Time unit to add list to specify the time unit you want to add.

Choose from the following time unit options:
• Millisecondi
• Secondi
• Minuti
• Ore
• Giorni
• Settimane
• Mesi
• Anni

Nota:  This action accounts for leap years. For example, if the action adds 28 days to February 1,
2020, the action output is February 29, 2020. Whereas, if the action adds 28 days to February 1,
2019, the action output is March 1, 2019.

5. Select the Datetime variable from the Assign the output to a variable list to specify the variable to
which you want to assign the output.

6. Fai clic su Salva.

To see the output value, convert the value in the Datetime variable to a String variable, then print the
value with the Message Box action. Per ulteriori informazioni, consulta Using the To string action alla
pagina 1475 e Using the Message box action alla pagina 1690.
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Utilizzo dell'azione Assegna
Use the Assign action to assign a String variable with a selected datetime format, assign a datetime value
manually, or assign an existing Datetime variable into a Datetime variable.
Per assegnare valori a una variabile Data e ora, effettua le seguenti operazioni:
1. Fai doppio clic o trascina l'action In stringa dal nodo Data e ora nella tavolozza Azioni.
2. Seleziona l'opzione Inserisci la data e ora o Variabile.

• Se hai selezionato l'opzione Inserisci la data e ora effettua le seguenti operazioni:
a. Immetti i valori di data e ora o seleziona una variabile Stringa.

Nota:  Per immettere più variabili, separale con virgolette singole. For example, to input the
variables date1 and time1, enter the following: 'date1"time1'

b. Seleziona il formato per data e ora.
Scegli tra i formati predefiniti o indica un formato personalizzato. Per ulteriori informazioni sui
formati predefiniti, consulta Datetime formats alla pagina 1475.

• Se hai sezionato l'opzione Variabile, scegli l'opzione Data e ora o l'opzione Variabile.
• Usa l'opzione Data e ora se vuoi selezionare manualmente la data, l'ora e il fuso orario.
• Usa l'opzione Variabile se desideri selezionare la variabile Datetime o altre variabili che

possono avere Datetime come sottotipo, come le variabili Dizionario, Record e Variabili elenco.

3. Seleziona la variabile da utilizzare per memorizzare l'output dall'elenco Variabile data e ora di
destinazione.

4. Fai clic su Salva.

Is after action in Datetime
The Is after action in the Datetime package compares two Datetime variables and verifies if the value
of the source variable is after the value available in the comparison variable, and stores the output to a
Boolean variable.

Impostazioni

• From the Source date and time variable section, select either the Datetime or Variable option.
Use the Datetime option to enter the date and time. Use the Variable option to select the global
value.

• Seleziona la variabile sorgente dall'elenco Variabile data e ora sorgente e seleziona la variabile che
desideri confrontare dall'elenco Variabile data e ora da confrontare con.

• Seleziona la variabile Data e ora dall'elenco Assegna l'output a una variabile per specificare la
variabile a cui desideri assegnare l'output.
Ad esempio, se il valore nella variabile di origine è successivo al valore nella variabile di confronto, il
sistema memorizza Vero come output nella variabile booleana. Se il valore nella variabile di origine
non è successivo al valore nella variabile di confronto, il sistema memorizza Falso come output nella
variabile booleana.
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Is before action in Datetime
The Is before action in the Datetime package compares two Datetime variables and verifies if the value of
source variable is before the value available in the comparison variable, and stores the output to a Boolean
variable.

Impostazioni

• Seleziona la variabile sorgente dall'elenco Variabile data e ora sorgente e seleziona la variabile che
desideri confrontare dall'elenco Variabile data e ora da confrontare con.

• Seleziona la variabile Data e ora dall'elenco Assegna l'output a una variabile per specificare la
variabile a cui desideri assegnare l'output.
Ad esempio, se il valore nella variabile di origine è precedente al valore nella variabile di confronto, il
sistema memorizza Vero come output nella variabile booleana. Ad esempio, se il valore nella variabile
di origine non è precedente al valore nella variabile di confronto, il sistema memorizza Falso come
output nella variabile booleana.

Is equal action in Datetime
The Is equal action in the Datetime package compares two Datetime variables and verifies if the value of
the source variable is equal to the value available in the comparison variable, and stores the output to a
Boolean variable.

Impostazioni

• Seleziona la variabile sorgente dall'elenco Variabile data e ora sorgente e seleziona la variabile che
desideri confrontare dall'elenco Variabile data e ora da confrontare con.

• Seleziona la variabile Data e ora dall'elenco Assegna l'output a una variabile per specificare la
variabile a cui desideri assegnare l'output.
Ad esempio, se il valore nella variabile di origine è uguale al valore nella variabile di confronto, il
sistema memorizza Vero come output nella variabile booleana. Se il valore nella variabile di origine non
è uguale al valore nella variabile di confronto, il sistema memorizza Falso come output nella variabile
booleana.

Using the Subtract action
Use the Subtract action to decrease the value in the Datetime variable by a specified time value and unit.
For example, you can use this action to decrease the Datetime variable value by three hours or by three
days.
To subtract a value from a Datetime variable, do the following:
1. Double-click or drag the Subtract action from the Datetime node in the Actions palette.
2. Select an option from the Source date and time variable list to specify the variable that contains

the value from which you want to subtract the time unit.
3. Enter the value you want to subtract in the Time value to subtract field.
4. Select an option from the Time unit to subtract list to specify the time unit you want to subtract.

Choose from the following time unit options:
• Millisecondi
• Secondi
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• Minuti
• Ore
• Giorni
• Settimane
• Mesi
• Anni

Nota:  This action accounts for leap years. For example, if the action subtracts 31 days from March
31, 2020, the action output is February 29, 2020. Whereas, if the action subtracts 31 days from March
31, 2019, the action output is February 28, 2019.

5. Select the Datetime variable from the Assign the output to a variable list to specify the variable to
which you want to assign the output.

6. Fai clic su Salva.

To see the output value, convert the value in the Datetime variable to a String variable, then print the
value with the Message Box action. Per ulteriori informazioni, consulta Using the To string action alla
pagina 1475 e Using the Message box action alla pagina 1690.

Using the To string action
Use the To string action to convert a datetime value to a string value. This action enables you to select a
predefined format or specify a custom format for the output value.
You can select a predefined format for datetime or provide a custom format based on your requirements.
Consulta Datetime formats alla pagina 1475.
To convert a datetime value to string, do the following:
1. Double-click or drag the To string action from the Datetime node in the Actions palette.
2. Select an option from the Source date and time variable list to specify the variable that contains

the datetime value that you want to convert to a string value.
3. Select an option from the Formats list to specify the predefined format in which you want to store

the string value.
4. Select the Custom format to specify a custom format based on your requirement.

Datetime formats alla pagina 1475

5. Select the string variable that you want to use to store the converted value from the Assign the
output to a variable list.

6. Fai clic su Salva.

Datetime formats
Specify a custom format when you convert a datetime value to a string value by using the predefined
formats available in RPA Workspace.
L'azione Stringa consente di convertire un valore data/ora in un valore stringa. Questa azione consente
inoltre di selezionare un formato temporale predefinito o di specificare un formato personalizzato.

Formato data/ora predefinito

Quando converti un valore data/ora in un valore stringa, i formati temporali predefiniti sono disponibili
nell'elenco Formati. Sono disponibili i seguenti formati di data/ora predefiniti:
• BASIC_ISO_DATE: Converts the datetime value to a yyyymmdd+offset value string value.
• ISO_LOCAL_DATE: Converts the datetime value to a yyyy-mm-dd string value.
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• ISO_OFFSET_DATE: Converts the datetime value to a yyyy-mm-dd+offset value string value. Il
valore di offset indica la differenza tra l'ora locale e UTC nel formato ore e minuti.

• ISO_DATE: Converts the datetime value to a yyyy-mm-dd+offset value or yyyy-mm-dd string
value. Il sistema aggiunge un valore di offset se disponibile.

• ISO_LOCAL_TIME: Converts the datetime value to a hh:mm:ss.SSS string value.
• ISO_OFFSET_TIME: Converts the datetime value to a hh:mm:ss.SSS+offset value string value.

Il valore di offset indica la differenza tra l'ora locale e UTC nel formato ore e minuti.
• ISO_TIME: Converts the datetime value to a hh:mm:ss.SSS, or hh:mm:ss.SSS+offset value

string value. Il valore di offset indica la differenza tra l'ora locale e UTC nel formato ore e minuti.
• ISO_LOCAL_DATE_TIME: Converts the datetime value to a yyyy-mm-ddThh:mm:ss.SSS string

value.
• ISO_OFFSET_DATE_TIME: Converts the datetime value to a yyyy-mm-ddThh:mm:ss.SSS

+offset value string value. Il valore di offset indica la differenza tra l'ora locale e UTC nel formato
ore e minuti.

• ISO_ZONED_DATE_TIME: Converts the datetime value to a yyyy-mm-ddThh:mm:ss.SSS
+offset value[zone id] string value. Il valore di offset indica la differenza tra l'ora locale e UTC
nel formato ore e minuti. The 'zone id' in the format represents the time zone.

• ISO_DATE_TIME: Converts the datetime value to a yyyy-mm-ddThh:mm:ss.SSS, yyyy-mm-
ddThh:mm:ss.SSS+offset value, or yyyy-mm-ddThh:mm:ss.SSS+offset value[zone id]
string value.

• ISO_ORDINAL_DATE: Converts the datetime value to a yyyy-[day of the year], or yyyy-
[day of the year]+offset value string value. Ad esempio, se il valore data/ora è '25 gennaio
2018', viene formattato come '2018-25' dove '25' indica il giorno dell'anno.

• ISO_WEEK_DATE: Converts the datetime value to a yyyy-[week of the year]-[day of the
 week], or yyyy-[week of the year]-[day of the week]+offset value string value. Ad
esempio, se il valore data/ora è '25 gennaio 2018', viene formattato come '2018-W4-4' dove 'W4' indica
che è la quarta settimana dell'anno e '4' indica il giorno della settimana.

• ISO_INSTANT: Converts the datetime value to a yyyy-mm-ddThh:mm:ss.SSSZ string value.
• RFC_1123_DATE_TIME: Converts the datetime value to a [day of the week], [day of

 the month] [month in 'MMM' format] [year in 'YYYY' format] hh:mm:ss, or [day
 of the week], [day of the month] [month in 'MMM' format] [year in 'YYYY'
 format] hh:mm:ss+offset value string value. Ad esempio, se il valore data-ora è '2018-01-25
10:15', è formattato come 'Thu, 25 December 2018 10:15:00GMT'. 'GMT' indica che non è disponibile
alcun offset.

Formato data/ora personalizzato

Usa le convenzioni predefinite per specificare un formato data/ora personalizzato. Sono disponibili le
seguenti convenzioni:

Nota:  All predefined conventions that are used to specify a custom datetime format are case-sensitive.

• 'y' and 'Y': Specify a year as 'yy' or 'yyyy' and specify the year of the week as 'YY' respectively.

Nota:  The ‘yy’ and ‘YY’ provide the same result, however the result differs if you use a datetime
format that includes the last week or the first week of a calendar year.
For example, when you use a datetime format as 12/26/22 (2022/12/26), then perform actions to
delete the files from the previous year, the datetime format ‘yy’ provides correct result (12/26/21) and
the files from the year 2021 are deleted. If you use the datetime format ‘YY’ (indicating the year of the
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week in which the specific day appears), then files from the year 2022 will be deleted because the day
12/26/21 falls during the last week of 2021 and also during the first week of 2022.

We recommend that you use the datetime format 'yy' when you want to consider the calendar year only
and not a specific week of that calendar year.

• 'M': specifica un mese come 'M', 'MM', 'MMM' (nome abbreviato del mese, per esempio, gen, feb), o
'MMMM' (nome completo del mese, per esempio, gennaio, febbraio).

Nota:  The 'MMM' and 'MMMM' datetime formats work depending on the operating system on which
the Bot Agent runs and your location setting.

• 'd': specifica un giorno come 'd' o 'dd'.
• 'D': specifica un giorno in un anno come 'D' o 'DD'.
• 'E': specifica il giorno della settimana come 'EEE' (Dom-Sab) o 'EEEE' (Domenica-Sabato).

Nota:  The 'EEE' and 'EEEE' datetime formats work depending on the operating system on which the
Bot Agent runs and your location setting.

• 'h' o 'H': specifica un'ora come 'hh' o 'HH'.

Nota:  HH is a 24-hour time format, and hh is a 12-hour time format with AM or PM. When you
use the hh format, add a at the end of the datetime format. For example, if the system locale
language is English, the input will be 2018-12-25 10:50:55.999 AM and the format will be yyyy-
MM-dd hh:mm:ss.SSS a where a indicates AM or PM. However, on computers that use operating
systems in languages other than English, use AM or PM marker accordingly. For example, on a
Japanese language operating system, the input must have AM or PM marker in Japanese, such as
2018-12-25 10:50:55.999 午前, where 午前 means AM in Japanese, and the format must be yyyy-MM-
dd hh:mm:ss.SSS a.

• 'a': Specifica un marcatore AM/PM per il formato orario di 12 ore
• 'm': specifica un minuto in un'ora come 'mm'.
• 's': specifica un secondo in un minuto come 'ss'.
• 'S': specifica un millisecondo come 'SSS'.
• 'z': specifica un fuso orario, come 'Pacific Standard Time' e 'Indian Standard Time'.
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• 'Z': specifica un tempo di offset per un fuso orario come '+0550' per 'Indian Standard Time'.

Important:  On computers where the display language is set to Simplified Chinese or Traditional Chinese,
when you use the dd-MMM-yyyy custom datetime format to convert a datetime value to a string value, the
output might show incorrectly.

Puoi utilizzare la convenzione precedente per specificare il formato personalizzato da utilizzare per
convertire un valore dataora. Alcuni esempi che usano la convenzione precedente sono i seguenti:

Formato Output campione

yyyy-MM-dd 2018-09-30

yyyy-M-d 2020-09-08

dd-MM-yyyy 25-12-2018

yyyy-MM-dd HH:mm:ss 2018-25-12 23:50:55

hh:mm:ss.SSS a 10:15:35.889 AM / 10:15:35.889 PM

yyyy-MM-dd HH:mm:ss.SSS 2018-12-25 23:50:55.999

yyyy-MM-dd HH:mm:ss.SSS Z 2018-12-25 23:50:55.999 +0530

h.mm a 4.10 PM

D 'days', yyyy 365 giorni, 2019

Delay package
Use the Delay package to add a timed delay to the logic.
You can use timed delay to add the amount of time a bot waits before moving to the next task. You can
specify the amount of time in milliseconds or seconds.

Nota:  You can specify a maximum time delay of 9999999 milliseconds or seconds.

Esempio: If we give a timed delay of 5 seconds, the bot will wait for 5 seconds and then execute the
action following the delay.
Il package Delay include le seguenti action:

Action Descrizione

Ritardo Consulta Delay action in Delay alla pagina 1478.

Delay action in Delay
Use the Delay action in the Delay package to add a timed delay.

Impostazioni

• Select the Delay type as Regular or Random.
• Select the Regular option to delay the operation for a fixed period of time.
• If you select Random, specify the time range in the From and To fields for the system to select a

random delay within the specified range.
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You can add Random delay with different waiting time for each bot run at a given command level
without having to change the bot.
Esempio: Use Random delay when running bots simultaneously on several machines through a
workload management queue before executing a database or recorder, or the FTP action. This would
reduce the number of concurrent requests made to a database or the FTP server and the performance
of the systems will not be adversely impacted.

• Select the Time unit in Milliseconds or Seconds.

Dictionary package
Il package Dizionario contiene actions che consentono di eseguire varie operazioni sui valori di tipo
dizionario.

Dictionary data type

A dictionary is a collection of key-value pairs, in which each key has a value. È simile a una voce di un
dizionario in cui ciascuna parola ha una definizione o una spiegazione corrispondente. La chiave è simile
alla parola e la definizione o spiegazione è simile al suo valore. The properties of dictionary entries are as
follows:
• Keys are unique within each dictionary variable. If you try to duplicate a key, you will overwrite its

value.
• Key names cannot be changed.
• Le chiavi sono sensibili alle maiuscole e alle minuscole.
• Le chiavi possono contenere spazi bianchi iniziali e finali.

Each key-value pair in a dictionary is separated by a colon. The key-value pairs are separated from each
other by commas. An example of a dictionary is as follows:

invoice = {'CustomerID': 9876, 'Location': 'XYZ', 'Amount': 12,34,567}

In the example, 'CustomerID', 'Location', and 'Amount' are keys, and the corresponding value assigned to
each key is separated by a colon.

Working with variables of dictionary data type

A dictionary variable can hold values of boolean, number, or string data subtype. Quando inizializzi una
variabile dizionario, è possibile selezionare il sottotipo Qualsiasi dato per conservare uno qualsiasi dei tre
sottotipi di dati. Puoi immettere manualmente i valori creando una nuova variabile o selezionandone una
esistente dal menu Variabili, quindi facendo clic su Aggiungi.
Utilizza una variabile dizionario per mantenere le proprietà di e-mail o PDF.

Nota:  When you use either the dictionary variable or the Get action from the Dictionary package to verify
whether a key exists in a dictionary variable and retrieve its corresponding value, different output displays
if the key does not exist:
• The dictionary variable retrieves a null value.
• The Get action retrieves a blank value.
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Actions in the Dictionary package

The following actions are available:

Action Descrizione

Assegna Consulta Assign action in Dictionary alla pagina 1480.

Get Consulta Get action in Dictionary alla pagina 1480.

Put Consulta Put action in Dictionary alla pagina 1480.

Rimuovi Consulta Remove action in Dictionary alla pagina 1481.

Dimensione Consulta Size action in Dictionary alla pagina 1481.

Attività correlate
Esempio di trasferimento di un valore tra bots alla pagina 2057
Scopri come trasferire un valore da un TaskBot all'altro utilizzando una variabile dizionario.

Assign action in Dictionary
Use the Assign action in the Dictionary package to assign the value of the source dictionary to the
destination dictionary variable.

Impostazioni

• Select the source dictionary variable from the drop-down list or create a new dictionary variable.
• Select a variable or create one to hold the output.

Get action in Dictionary
Use the Get action in the Dictionary package to verify if a key exists in a dictionary variable and return the
corresponding value.

Impostazioni

• Select the dictionary variable from the drop-down list.
• Enter the key name.
• Select a dictionary variable or create one to hold the output.

Put action in Dictionary
Use the Put action in the Dictionary package to assign a value to a key in the dictionary. Se la chiave è già
associata a un valore, il valore può essere aggiornato.

Impostazioni

• Select the dictionary variable from the drop-down list.
• Enter the key name.
• Assegna un valore alla chiave.
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È possibile scegliere la scheda Valore statico per aggiungere i valori manualmente o la scheda
Variabile per aggiungere le variabili esistenti.

Nota:  Se scegli l'opzione Valore statico, assicurati che il tipo di dati del valore statico corrisponda al
sottotipo della variabile dizionario. Altrimenti, potresti riscontrare errori di tipo cast quando utilizzi le
variabili del dizionario.

• Select the variable to hold the previous value.

Remove action in Dictionary
Use the Remove action in the Dictionary package to remove a value from the specified key. Il valore
rimosso viene assegnato a una variabile selezionata dall'elenco Assegna l'elemento rimosso alla
variabile.

Impostazioni

• Select the dictionary variable from the drop-down list.
• Enter the key name.
• Select the variable to hold the removed value.

Size action in Dictionary
Use the Size action in the Dictionary package to retrieve the number of entries in the dictionary.

Impostazioni

Recupera il numero di voci nel dizionario specificato nel campo Variabile dizionario e assegna l'output a
una variabile numero specificata nell'elenco Assegna l'output alla variabile.

DLL package
A dynamic-link library (DLL) file contains a shared library of functions that can be used by Windows
programs. The DLL package uses a .dll file as reference and calls functions from the bot.

Prima di iniziare

Perform the following actions within the DLL package as part of using the set of available actions:

Nota:
• If you create bots using custom DLL, and the custom DLL has a dependency on the Apache log4net

library, then we recommend using:
• log4net version 2.0.11 or later in the custom DLL.
• Update the Bot Agent (version 21.210 or later) even if the Bot Agent update is optional.

• Only the DLLs built using the Microsoft .NET Framework are supported.
• The Run DLL package is compatible with the following versions of Microsoft .NET: 4.6, 4.7, and 4.8.
• When you create a bot and use the local session with loop, ensure that you use the close session

action in the bot. If you do not use the close session command, then the local session will open
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AutomationAnywhere.ManagedDLLWrapper.exe with each iteration of the loop. As a result, you
will run out of memory space and the bot will fail.

Important:  If you use different versions of the DLL package in a parent bot and a child bot, the
capability to share a session across bots is currently not supported. To share a session across parent and
child bots, ensure that you use the same version of the package in both the parent and child bots.

1. Use the Open action to specify the location of the .dll file you want to use and session name.
Utilizza questo stesso nome di sessione per le altre actions. The .dll referenced is automatically
added as a bot dependency.

2. Use the Run function action to run a function from the .dll and save its output value as a variable.
3. After running the required functions, close the .dll reference. It is important to close the .dll

reference to free the memory of the operating system.
Windows and appropriate versions of Microsoft .NET Framework are available on the devices running
the DLLs.
To review the bot launcher logs, navigate to C:\ProgramData\AutomationAnywhere
\BotRunner\Logs\<current month>\Bot_Launcher-<today's date>.log.zip. Each
zipped folder contains a file with data on the code execution, which is useful for debugging.

Nota:  Se il file .dll utilizza le funzioni o le classi .NET di un altro file .dll, è necessario aggiungere il
secondo file .dll come dipendenza manuale del bot.
Bot dependencies alla pagina 2046

When you import multiple DLLs that have one main DLL and other DLLs are referenced from it, ensure
you have all the DLLs in one folder. Also, the referenced DLLs must be called using a session name that is
different from the name used in the main DLL. Your bot execution will fail if the same session name is used
in both the main and the referenced DLLs.

Actions in the DLL package

The DLL package includes the following actions:

Action Descrizione

Chiudi Vedi Close action alla pagina 1486

Apri Vedi Open action alla pagina 1486
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Action Descrizione

Esegui funzione
(legacy)

See Using the Run function action.

Nota:
• L'action Esegui funzione (Legacy) non è più disponibile nel package

Run DLL. Si raccomanda di utilizzare l'action Esegui funzione dal
package Run DLL poiché questa action è una versione migliorata
dell'action Esegui funzione (Legacy).
Notare che i bots esistenti che utilizzano Esegui funzione (Legacy)
continueranno a essere eseguiti correttamente senza alcun problema.

• This action is called Run function (Legacy) starting from Enterprise
A2019.16. The action is called Run function in Enterprise A2019.15
and previous releases.

Esegui funzione Consulta Utilizzo dell'action Esegui funzione alla pagina 1488.

Supported data types in DLL functions

The following table list the variables and data types that you can use as an input or output parameter in
DLL functions.

Nota:  The Run function and Run function (Legacy) actions do not support any user-defined data
types in the Parameter to the function or Assign output to variable field.

Variable type as input or output parameters Supported data types in .NET

Stringa • Char
• Byte
• Stringa
• stringa
• SByte

Numero • UInt16
• Int16
• UInt32
• Int32
• UInt64
• Int64
• Int
• Singolo
• Decimal
• Float
• Doppio

Operatore booleano • Operatore booleano
• bool
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Variable type as input or output parameters Supported data types in .NET

Data e ora • Data e ora

Elenco • UInt16[]
• Int16[]
• Int32[]
• Int64[]
• Int[]
• Char[]
• Single[]
• Decimal[]
• Float[]
• Double[]
• Boolean[]
• bool[]
• Byte[]
• String[]
• Datetime[]
• List<UInt16>
• List<Int16>
• List<Int32>
• List<Int64>
• List<Int>
• List<Char>
• List<Single>
• List<Decimal>
• List<Float>
• List<Double>
• List<Boolean>
• List<bool>
• List<Byte>
• List<String>
• List<Datetime>
• List<SByte>
• List<UInt32>
• List<UInt64>

Nota:  The C# IList data type is not supported
and does not work with the Automation 360 List
data type.
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Variable type as input or output parameters Supported data types in .NET

Tabella • UInt16[,]
• Int16[,]
• Int32[,]
• Int64[,]
• Int[,]
• Char[,]
• Single[,]
• Decimal[,]
• Float[,]
• Double[,]
• Boolean[,]
• bool[,]
• Byte[,]
• String[,]
• Datetime[,]
• Byte[,]
• UInt32[,]
• UInt64[,]

Nota:  The Table type variable is equivalent to
a two-dimensional array type variable in .NET.
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Variable type as input or output parameters Supported data types in .NET

Dizionario • Dictionary<String,UInt16>
• Dictionary<String,Int16>
• Dictionary<String,Int32>
• Dictionary<String,Int64>
• Dictionary<String,Int>
• Dictionary<String,Char>
• Dictionary<String,Single>
• Dictionary<String,Decimal>
• Dictionary<String,Float>
• Dictionary<String,Double>
• Dictionary<String,Boolean>
• Dictionary<String,bool>
• Dictionary<String,Byte>
• Dictionary<String,String>
• Dictionary<String,Datetime>
• Dictionary<Int,String>
• Dictionary<Decimal,String>
• Dictionary<Boolean,String>
• Dictionary<String,SByte>
• Dictionary<String,UInt32>
• Dictionary<String,UInt64>

Nota:  When creating the .Net DLL function,
use the IDictionary data type instead of the
Dictionary data type.

Attività correlate
Example of using the DLL package alla pagina 2061
Build a very simple DLL that will generate a message. Create a bot to run the DLL.

Close action
The Close action in the DLL package enables you to close the DLL reference.

Impostazioni

Closes the current session. In the Session name field, enter the name of the session.

Open action
The Open action in the DLL package enables you to open the reference file.

Impostazioni

• In the File path field, specify the location of the path.
• Select any of the following tabs to specify the location of the DLL you want to use:

• File Control Room: Use a DLL that is available in the Control Room.
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• File desktop: Use a DLL that is available on a device.
• Variabile: Use a file variable to specify the location of the DLL.

• Select any of the following tabs to create a DLL session:
• Sessione locale: Specifica un nome sessione utilizzabile solo nel bot corrente.
• Sessione globale: Specifica un nome sessione utilizzabile in più bots come bots padre, bots figlio e

altri bots figli dei bots padre.
Consulta Sharing sessions across bots alla pagina 1487.

• Variabile: Specifica una variabile di sessione utilizzabile per condividere quella sessione con altri
bots figlio.
When you run the bot, it passes the session variable to the child bot, which enables the child bot to
use the DLL opened in the parent bot.

Nota:  The DLL package supports only DLLs written in C#.

Sharing sessions across bots
You can share a session across multiple bots so that you can use the same DLL, Microsoft Excel worksheet,
and terminal across these bots. You can share a session across child bots, parent bots, and other child bots
of the parent bots.
Use the Global session option in the Open action of the DLL package to pass on the exact state of an
application or DLL from one bot to another bot and vice versa.
Sharing a session eliminates the need to repeatedly open and close a session when using the same file
across multiple bots. When you share a session across bots, all subsequent actions in that bot, child bots,
parent bots, and other child bots of the parent bots can use that DLL session without any additional steps
by using the same global session name in these bots.
For example, consider you have added the Open action with the Global session selected at the eighth
line of a bot. All the actions that are executed after the eighth line in the current bot, child bots, and
parent bots can use that DLL session without any additional step.

Nota:  Use the Open action to open a global session as the first action in your bots.

Using the Run function (Legacy) action
Use the Run function (Legacy) action to run a function within the .dll file and specify the parameters
to pass a function and store the output as a variable.
• Use a dictionary variable to pass the parameters to a function. The dictionary key contains the

parameter name to pass to a function.
• Se il file .dll utilizza le funzioni o le classi .NET di un altro file .dll, è necessario aggiungere il

secondo file .dll come dipendenza manuale del bot.
Bot dependencies alla pagina 2046

• Quando utilizzi le action Esegui funzione o Esegui funzione (Legacy), assicurati di utilizzare i tipi di
dati supportati per le funzioni DLL.
Consulta DLL package alla pagina 1481.

Follow these steps to run a function:
1. In the Actions palette, double-click or drag the Run function (Legacy) action from the DLL

package.
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2. Nel campo Nome sessione, inserisci un nome per la sessione.
3. Nel campo Immetti spazio dei nomi, specifica lo spazio dei nomi.

Puoi specificare uno qualsiasi degli spazi dei nomi definiti nel file DLL.

Nota:  Assicurati che il valore fornito nel campo sia corretto.

Importante:  Questo campo è sensibile alla distinzione tra maiuscole/minuscole.

4. Nel campo Immetti il nome della classe, specifica il nome della classe.
You can specify the name of any classes available in the namespace.

Importante:  Questo campo è sensibile alla distinzione tra maiuscole/minuscole.

5. Nel campo Immetti il nome della funzione da eseguire, specifica il nome della funzione da
eseguire.
Ensure that the name you have provided is correct and available in the class specified in the previous
step.

Importante:  Questo campo è sensibile alla distinzione tra maiuscole/minuscole.

6. Opzionale: In the Parameters to the function list, select the variable that contains all the
parameters needed by the function.
You can use Boolean, datetime, dictionary, list, number, string, or table variable types to pass
parameters to the function.

Nota:  Use the dictionary subtype Any to enable the bot to pass parameters of different data types to
the function including Boolean, numeric, and string.

Specify the dictionary key as the parameter name to provide the dictionary value as the parameter
value. For example, you have a function ReturnSum that returns the sum of two numeric values and
want to pass Param1 and Param2 as its parameters. Configure a dictionary variable with two keys:
Param1 and Param2, each with the value that you want to pass.

7. Opzionale: Nell'elenco Assegna output a una variabile, seleziona una variabile da utilizzare per
memorizzare l'output della funzione.
Puoi utilizzare i tipi di variabile booleana, data/ora, dizionario, elenco, numero, stringa o tabella per
archiviare l'output in base al tipo di output restituito dalla funzione.

8. Fai clic su Salva.

Utilizzo dell'action Esegui funzione
Utilizza l'action Esegui funzione per eseguire una funzione all'interno di un file .dll e specificare i
parametri per passare una funzione e archiviare l'output come variabile.
• Questa action consente di passare un parametro di qualsiasi tipo. Se desideri utilizzare una variabile

dizionario per passare i parametri a una funzione, utilizza l'action Esegui funzione (Legacy).
Using the Run function (Legacy) action alla pagina 1487

• L'azione Esegui funzione non supporta l'utilizzo di Windows Form.
• Se il file .dll utilizza le funzioni o le classi .NET di un altro file .dll, è necessario aggiungere il

secondo file .dll come dipendenza manuale del bot.
Bot dependencies alla pagina 2046

• Questa action supporta funzioni sovraccaricate a partire da Enterprise A2019.17. L'action può gestire file
.dll che contengono più funzioni con lo stesso nome. Essa richiama la funzione in base al numero di
parametri passati.
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• Quando utilizzi le actions Esegui funzione o Esegui funzione (Legacy), assicurati di utilizzare i tipi
di dati supportati per le funzioni DLL.
DLL package alla pagina 1481

Per eseguire una funzione, attieniti alla seguente procedura:
1. Nella tavolozza Actions, fai doppio clic o trascina l'action Esegui funzione dal package DLL.
2. Nel campo Nome sessione, inserisci un nome per la sessione.
3. In the Enter the namespace (Optional) field, specify the namespace.

Puoi specificare uno qualsiasi degli spazi dei nomi definiti nel file DLL.

Nota:  Assicurati che il valore fornito nel campo sia corretto.

Importante:  Questo campo è sensibile alla distinzione tra maiuscole/minuscole.

4. Nel campo Immetti il nome della classe, specifica il nome della classe.
You can specify the name of any of the classes available in the namespace.

Importante:  Questo campo è sensibile alla distinzione tra maiuscole/minuscole.

5. Nel campo Immetti il nome della funzione da eseguire, specifica il nome della funzione da
eseguire.
Ensure that the name you have provided is correct and available in the class specified in the previous
step.

Importante:  Questo campo è sensibile alla distinzione tra maiuscole/minuscole.

6. Opzionale: Nella sezione Parametri di input, fai clic sul pulsante Aggiungi parametri.
a) Nella finestra di dialogo Dettagli parametri DLL, nel campo Nome parametro, inserisci il

nome del parametro.
b) Dall'elenco Tipo di parametro, seleziona un tipo di dati.

Per il tipo di dati Integer (UInt16, Int16, Int32, Int64, Int, Single, Float, Decimal, Double, UInt32
o UInt64), puoi usare un valore da un credential vault o una variabile credenziale come parametro
di input.

c) Nel campo Valore, immetti il valore da passare.
Se selezioni il tipo di dati Integer, puoi scegliere tra le seguenti opzioni:

• Numero: Nel campo Numero, immetti il valore da passare.
• Credenziale: Per utilizzare un valore da un credential vault, seleziona Credenziale. Per utilizzare

una variabile credenziale, seleziona Variabile.

Per maggiori informazioni sui credential vault e su come usarli, vedi Credentials and lockers in the
Credential Vault alla pagina 2839.
Ripeti il passaggio 6 per aggiungere più parametri.

Importante:  I nomi dei parametri aggiunti e il loro ordine devono essere gli stessi della funzione
DLL.

7. Use the Run function in background option when no Windows system-related operations, such
as such as keystroke, mouse click, or window switching, are called under the C# DLL. You can select
the Run function in background check box to bypass the intermediate window (AAZeroSizeForm)
and run the C# DLL under the console application without the form. We recommend that you select
this check box if the DLL function is not interacting with the Windows API to perform operations
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such as keystroke, mouse click, or window switching. Questa funzionalità aiuta anche a migliorare
le prestazioni di esecuzione della DLL se la casella di controllo Esegui funzione in background è
selezionata.

8. Opzionale: Nell'elenco Assegna output a una variabile, seleziona una variabile da utilizzare per
memorizzare l'output della funzione.
Puoi utilizzare i tipi di variabile booleana, data/ora, dizionario, elenco, numero, stringa o tabella per
archiviare l'output in base al tipo di output restituito dalla funzione.

9. Fai clic su Salva.

Document Extraction package
The Document Extraction package enables you to extract data from documents and download that data.
This package is for processing documents in Document Automation.
When a new learning instance is created, the Control Room automatically creates a folder with the same
name as the learning instance in the Automation > Document Workspace folder. Within that folder,
the Control Room creates the following two bots:
• Extraction bot: Consente di estrarre i dati dai campi definiti nei documenti caricati.
• Download bot: Consente di scaricare i dati estratti in una cartella specifica sulla periferica o sulla rete

condivisa.

Actions nel package Document Extraction

This package includes the following actions:

Action Descrizione

Download data Vedi Using Download data action alla pagina 1492

Estrai dati Vedi Using Extract data action alla pagina 1490

Concetti correlati
Document Automation alla pagina 2553
Document Automation è la nuova soluzione nativa del Cloud per l'elaborazione intelligente dei documenti
che gli utenti aziendali possono impostare per leggere ed elaborare automaticamente e rapidamente i
documenti utilizzando modelli preaddestrati e feedback di convalida.
Attività correlate
Creare un'istanza di apprendimento in Document Automation alla pagina 2567
Begin processing documents by creating a learning instance to extract data from invoices, utility bills, or
receipts. Un'istanza di apprendimento è una struttura che contiene informazioni come il tipo di documento,
la lingua e i campi da estrarre.

Using Extract data action
TaskBots use the Extract data action to process documents uploaded to Document Automation.
When you create a learning instance in Document Automation, the Control Room automatically creates the
extractionbot. To edit this bot, navigate to Automation > Document Workspace, select the folder
with the same name as the learning instance, and open the extractionbot.
The following table describes the action fields.

Nota:  We do not recommend changing the variables in these fields as that might break the process.
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Campo Descrizione

Document to extract File path to the uploaded document

Nome dell’istanza di apprendimento Name of the learning instance associated with
this bot

Output results Specify where to hold Document Automation
data:
• Uploaded to Document Automation

server: Data generated during extraction is
uploaded to the server for further processing
(such as validation) and later downloaded by
a bot running the Download data action.

• Saved to local folder: Data generated
by Document Automation is not sent to the
server and is saved to the specified folder
path.

Nota:  If you select this option, Document
Automation does not send files for validation,
since that requires the use of the Document
Automation server. In addition, you can
remove the bot running the Download data
action from the process, since selecting this
option makes that bot redundant.

Service account If the learning instance associated
with this bot will process documents in
Google Document AI, click Pick to select the
credential that contains your Google Document
AI security token.

Document AI endpoint URL If the learning instance associated with
this bot will process documents in Google
Document AI, provide the URL to your service
account.

GroupLabel (optional) If the learning instance was created in
Automation 360 IQ Bot and connected to
Document Automation, this field is auto-filled
with the applicable document group name.

Attività correlate
Creare un'istanza di apprendimento in Document Automation alla pagina 2567
Begin processing documents by creating a learning instance to extract data from invoices, utility bills, or
receipts. Un'istanza di apprendimento è una struttura che contiene informazioni come il tipo di documento,
la lingua e i campi da estrarre.

Configure Extract action to process documents in Google Document AI
Provide the credential that is holding the Google Document AI API key to the Extraction bot.
• Configure key for Google Document AI alla pagina 2566
• Creare un'istanza di apprendimento in Document Automation alla pagina 2567
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• Login to your Google Document AI account, navigate to the processor, and set the default version to
pretrained-invoice-v1.1-2021-04-09

• Copy the Google Document AI prediction endpoint

1. Navigate to Automation > Private tab > Document Workspace and click the folder with the
same name as the learning instance to configure the bot.

2. Open the Extraction bot and click the Document Extraction action to edit it.
3. In the Service account field, click Pick to select the doc-ai-credential credential.
4. Provide the Google Document AI prediction endpoint URL.
5. Fai clic su Salva.

Using Download data action
TaskBots use the Download data action to download data from successfully processed documents in
Document Automation.
When you create a learning instance in Document Automation, the Control Room automatically creates the
downloadbot. To edit this bot, navigate to Automation > Document Workspace, select the folder
with the same name as the learning instance, and open the process. By default, the process contains four
downloadbots. You can edit the output format in the bots: Change output format from CSV to JSON alla
pagina 2580

Importante:  Only edit the bots in the process. We do not recommend editing the downloadbot in the
folder with the same name as the learning instance.

The following table describes the Download data action fields:

Campo Descrizione

Document Id The document to download

Tipo di documento The output file type:
• Output file (CSV): Used for downloading

successfully processed documents to CSV
format.

• Output file (JSON): Used for downloading
successfully processed documents to JSON
format.

• Input file: Used for downloading failed
documents in the file type that they were
uploaded.

Percorso della cartella di output Specifies the file path where to download the
document

Elimina i file Removes files from the Document Automation
server after they are downloaded

Riferimenti correlati
About the AARI process in Document Automation alla pagina 2574
Document Automation uses Automation Anywhere Robotic Interface technology to manage the end-to-end
document extraction process. When you create a learning instance in Document Automation, the system
also creates an AARI process. Review the following guide to understand the logic.
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Email package
Il package Email contiene actions per automatizzare le attività correlate alle e-mail tramite Exchange Web
Services (EWS), Microsoft Outlook e altri server e-mail. You can use these actions for sending, receiving,
and modifying messages, folders, and the status of messages.

Nota:
• The Email package supports the email automation of a shared mailbox in Outlook for Office 365/

Microsoft 365 using IMAP/EWS protocols, and OAuth 2.0 authentication using Client Credentials and
Authorization Code with PKCE grant flows. You can automate emails retrieved from a shared mailbox
and perform email-related tasks by accessing each folder(s) and its subfolder(s) in the shared mailbox.
Ensure that you have set up the shared mailbox in your Outlook application. Note that sending,
forwarding, and replying to emails using a shared mailbox is not supported.

• Proxy is supported for EWS OAuth 2.0. When you create a bot that uses EWS OAuth2 for authentication
and the Bot Runner machine is configured behind the firewall, then all outbound requests are routed
through the proxy server configured on the Bot Runner machine.

• When you read emails in a loop using a Microsoft Outlook Client connection with a subject filter, the bot
cannot read undelivered emails, if the subject contains these receipts:
• Delivery receipt
• Read receipt
• Undelivered receipt

Outlook client does not support this feature due to the third-party library it uses.
We recommend that you use Email server > IMAP to connect, read and filter such emails.

Il package Email supporta i protocolli EWS, POP3, SMTP e IMAP e consente di eseguire le seguenti
operazioni:
• Gestire e organizzare messaggi e cartelle e-mail.
• Scaricare allegati e-mail in cartelle specifiche sui dispositivi.
• Estrarre i dati dalle e-mail nelle variabili da utilizzare come dati estratti in altre applicazioni. Ad esempio,

puoi estrarre i dati relativi al mittente di un'e-mail e memorizzarli in un foglio di calcolo Microsoft Excel.

Nota:  Se desideri automatizzare un'attività correlata all'e-mail utilizzando Microsoft Outlook su un
dispositivo, assicurati che l'applicazione Outlook sia aperta.

Nota:
• If your current office installation is any of the following:

• Microsoft 365 Apps for Enterprise
• Office 2016, 2019, or 2021 (Consumer Version 2009 or later)

Then you do not need to install the Microsoft Access Database Engine as an additional component in
your system.
However, if you have both Microsoft 365 Apps and the Microsoft Access Database Engine are installed
on your system, then you can uninstall the Microsoft Access Database Engine and repair Microsoft 365
Apps.
Microsoft recommends that you do not install the Microsoft Access Database Engine driver separately
because both the Microsoft Access Database Engine 2016 and Microsoft 365 Apps use the same major
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version identifier (16.0). To learn more about the Microsoft Access Database Engine driver installation
requirement, see Unable to use the Access ODBC or OLEDB provider

• When you send an email, reply, or forward, the attachment size allowed in the email depends on your
internet speed (timeout of 120 seconds) and the email server restrictions. If sending an attachment
takes more than 120 seconds, the system displays an error due to timeout.

Considerations

Nota:  Alcune actions devono essere utilizzate all'interno di un'action Loop. Consulta Using the For each
mail in mail box iterator alla pagina 1517.

Le e-mail vengono recuperate in base alla sequenza delle cartelle elencate nel campo della posta in arrivo.
All'interno di ogni cartella, le e-mail vengono recuperate in base alla data e all'ora di ricezione nell'ultimo
ordine in entrata e del primo in uscita (LIFO). Inoltre, puoi applicare filtri ai seguenti campi:
• Tipi di e-mail: Tutto, Letto e Non letto
• Oggetto
• Da una cartella specifica
• Per specifico mittente
• Prima, dopo o nella data di ricezione

Adhere to the following best practices when you filter and loop through folders that contain a large number
of email messages:
• After you have processed email messages, move them to another folder so that their duplicate email

messages are not processed again during a subsequent run.
• Try to reduce the number of messages in the mailbox.
• The filtration works on the filter parameters provided by the user, such as type of email: All, Read, and

Unread; Subject; from a specific folder; from a specific sender; or before, on, or after received date).
Following are the types of filter mechanisms:
• Email server-side: The filtration that takes place on the server-side is much faster.
• Client-side: Filtration is performed on the local machine and is comparatively slow because the

mail messages are first retrieved from the remote server and then filtered in the local machine.
• Hybrid: Some parameters are filtered on the server side and some on the client side.

• Here is an explanation of how the filtration process works for various server types:
• EWS: All filtration is done on the server side and is hence much faster.
• Outlook client: Nothing is filtered on the server side, but the filtration process is faster because

email messages are already present on the local machine.
• IMAP: Filtration for the Subject field is performed on the local machine and is slower. For the

Before, on, or after received date parameter, the filtration for date is performed on the remote
server, and for hour/min/second, it is performed on the local machine. For example, for the date
01/12/2022, filtration is performed on the remote server whereas for the time (hour/min/sec)
21:10:56, filtration is performed on the local machine.

• POP3: This server is the slowest of all because mails are retrieved from the remote server, and
filtration is done in the local machine.

We recommend connecting using the EWS server and Outlook client as the filtration process is much
faster when compared to IMAP and POP3 protocols.

• Always use the Disconnect action if the Connect action is used to release a resource.
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Prima di iniziare

Esegui le seguenti actions contenute nel package Email come parte integrante dell'utilizzo del set di
actions disponibili:
1. Stabilisci una connessione con un server e-mail utilizzando l'action Connetti.

Durante la creazione della connessione, devi specificare i dettagli e il nome di sessione del server e-
mail. Utilizza questo stesso nome di sessione per le altre actions.
Non è necessario stabilire una connessione per le actions Inoltra, Rispondi e Invia poiché potrai
aggiungere i dettagli del mittente e del server e-mail quando utilizzerai queste actions.

2. Utilizza le actions per automatizzare un'attività.
3. Dopo aver automatizzato tutte le attività correlate alle e-mail, termina la connessione al server di

posta utilizzando l'action Disconnetti.

Importante:  È necessario abilitare le impostazioni POP per automatizzare un'attività correlata alle e-mail
sul server Gmail utilizzando il protocollo POP3 Vedi Lettura dei messaggi Gmail tramite POP.

Actions nel package Email

Il package Email include le seguenti actions:

Action Descrizione

Cambia stato Consulta Change status action alla pagina 1496.

Verifica se la cartella
esiste

Consulta Check if folder exists action alla pagina 1496.

Elimina tutti Consulta Delete all action alla pagina 1496.

Elimina Consulta Elimina action alla pagina 1497.

Disconnetti Consulta action Disconnetti alla pagina 1497.

Connetti Consulta Using Connect action for Email alla pagina 1497.

Inoltra Consulta Using the Forward action alla pagina 1503.

Sposta tutti Consulta Move all action alla pagina 1506.

Sposta Consulta Move action alla pagina 1507.

Rispondi Consulta Using Reply action alla pagina 1508.

Salva tutti gli allegati Consulta Save all attachments action alla pagina 1510.

Salva gli allegati Consulta Save attachment action alla pagina 1511.

Salva messaggio Consulta Save email action alla pagina 1511.

Invia Consulta Utilizzo di Invia action alla pagina 1512.

Riferimenti correlati
Loop package alla pagina 1681
Utilizza il Loop Pacchetto per eseguire una sequenza di actions ripetutamente per un numero specifico di
volte o fin quando una condizione specifica non sarà soddisfatta.
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Impostazioni del server di posta elettronica alla pagina 1502
I dettagli relativi al server di posta forniti quando stabilisci una connessione variano in base al server e-mail
a cui ti stai collegando.
Using dictionary variable for email properties alla pagina 1519
When you automate an email-related task, RPA Workspace retrieves various properties of an email and
stores the values of these properties in a dictionary variable. These properties are stored in a dictionary
variable when you use an email action within a loop action.

Change status action
The Change status action in the Email package enables you to change the statuses of emails to read or
unread. Utilizza questa action all'interno di un'action Loop.

Impostazioni

• In the Session name field, enter the name of the session that you used to connect to the email server
in the Connect .

• Change status to: Seleziona l'opzione Letto o Non letto per cambiare lo stato dell'e-mail.

Nota:
• Microsoft Outlook supports this action.
• I server POP3 non supportano e mantengono lo stato di lettura o non lettura delle e-mail.

Check if folder exists action
Use the Check if folder exists action in the Email package to verify whether a folder with the name you
specified exists in the email server.

Impostazioni

• In the Session name field, enter the name of the session that you used to connect to the email server
in the Connect .

• Nel campo Nome cartella, immetti il nome della cartella che desideri selezionare.

Nota:  Questo campo non è sensibile alla distinzione tra maiuscole/minuscole.

• In the Select the destination boolean variable list, select a Boolean variable to store the output
of the result. The output is either True (folder exists) or False (does not exist). La  mostra un nome
descrittivo predefinito della variabile. If you create several output variables, subsequent variable names
are appended with a -1, -2, -3, and so on to avoid duplication.

Delete all action
Use the Delete all action in Email package to delete read, unread, or all emails from the specified folder.

Impostazioni

• In the Session name field, enter the name of the session that you used to connect to the email server
in the Connect .
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• Seleziona l'opzione Tutto, Letto o Non letto per specificare il tipo di e-mail da eliminare.

Nota:
• Per un server e-mail che utilizza il protocollo POP3, questa action elimina tutti i messaggi e-mail.
• Microsoft Outlook attualmente non supporta questo action.

Elimina action
Use the Delete action in Email package to delete the specified email from the inbox. Use this action within
a Loop action.

Impostazioni

In the Session name field, enter the name of the session that you used to connect to the email server in
the Connect .

Nota:  Microsoft Outlook supports this action.

action Disconnetti
Use the Disconnect action in Email package to terminate the connection established with the email server.

Impostazioni

In the Session name field, enter the name of the session that you used to connect to the email server in
the Connect .

Using Connect action for Email
Utilizza l' action Connetti per stabilire una connessione con un server e-mail. Questa è la prima action che
devi usare per automatizzare un'attività correlata all'e-mail.
You can use OAuth 2.0 to authenticate with the email server for email automation. Based on your email
service provider, perform the relevant steps:
• Outlook/Office 365

• If you use Client credentials flow authentication mode, then perform the following steps:
1. Log in to the Microsoft Azure portal.
2. Register an application with the Microsoft identity platform to obtain the client ID and tenant ID.

See Register an application.
3. Add a Client secret. See Add a client secret.
4. Based on which mail server you connect to, perform the relevant steps:

• IMAP/POP3
Add the POP and IMAP permissions to your AAD application . See Authenticate an IMAP, POP
or SMTP connection using OAuth.

• EWS
• Configure for app-only authentication. See Configure for app-only authentication.
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• Configure an application access policy and limit the scope of application permissions. See
Configure application access policy.

• If you use the Authorization code with PKCE authentication mode, then perform the following
steps:
1. Log in to the Microsoft Azure portal.
2. Register an application with the Microsoft identity platform to obtain the client ID and tenant ID.

See Register an application.
3. When registering the application, set the redirect URI to http://localhost:9999/

callback.
4. Add permissions with type delegated for IMAP, POP3, and SMTP and grant the application the

required permission for Microsoft Graph to the application.

• Gmail
To authorize your application with Gmail using the Authorization code with PKCE authentication
method, perform the following steps:
1. Configure the OAuth2.0 settings in the Google Cloud Platform (GCP) and retrieve the necessary

credentials to connect Automation 360 with your G Suite applications.
2. If you have not already done so, create a project.
3. To generate the Client ID and Client secret, complete the steps in Setting up OAuth 2.0.

Nota:
• Select the Web application option.
• Add this authorized redirect URI: http://localhost:8888/Callback.

4. Complete the steps to set up user consent for the username that you will use to connect to the
Automation 360.

Nota:
• Client Credentials flow does not support Gmail.
• The Client Credentials and Authorization code with PKCE authentication modes do not support Yahoo

and MSN mail servers.

Important:  If you want to use both the authentication mode (Client credentials and Authorization code
with PKCE), you must register on two separate applications.

Nota:  Quando si effettua la connessione a un server Exchange web Services, è necessario disattivare
l'autenticazione a più fattori, inclusi tutti i criteri di protezione a livello aziendale in cui è possibile attivare
l'autenticazione a più fattori. If multi-factor is not disabled completely, users can encounter connection or
authorization errors.
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Questa action ti consente di fornire le credenziali e i dettagli del server e-mail, nonché associare queste
informazioni a un nome sessione. Utilizza questo stesso nome sessione per le altre actions Email in modo
da fornire le informazioni sul server una sola volta.
Per stabilire una connessione con un server e-mail, attieniti alla seguente procedura:
1. Nella tavolozza Actions, fai doppio clic o trascina l'action Connetti dal package Email.
2. Inserisci un nome della sessione.
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3. Nell'opzione Outlook, Server e-mail o EWS, specifica se desideri stabilire una connessione con
Microsoft Outlook o con un server di posta.
When you establish a connection with Microsoft Outlook, email messages are processed from the
shared mailbox. Ensure that you have set up the shared mailbox in your Outlook application.

Nota:
• This feature is supported only for Outlook.
• You can select only one mailbox from the list of mailboxes in the shared mailbox.
• The meeting invitation is not read in Outlook because the bot does not select calendar invites as

email objects. This feature is not currently supported.

• Se hai selezionato l'opzione Outlook non sono necessari ulteriori dettagli.
• Se hai selezionato l'opzione Server e-mail, compila i seguenti campi:

Nota:  Per informazioni sugli host e le porte da utilizzare per i vari server di posta, vedi
Impostazioni del server di posta elettronica alla pagina 1502.

• Usa connessione sicura (SSL/TLS): seleziona questa opzione se desideri utilizzare una
connessione sicura con il server di posta.

• Host: Enter the name of the mail server.

Nota:  Questo campo non è sensibile alla distinzione tra maiuscole/minuscole.

• Porta: Enter the port number of the server.
• Protocollo: Select either IMAP or POP3 protocol.
• Authentication mode: Choose from the following authentication modes:

• Basic: Uses the username and password.
• OAuth2 – Authorization code with PKCE: See Microsoft identity platform and OAuth 2.0

authorization code flow
• OAuth2 – Client credentials: See Microsoft identity platform and the OAuth 2.0 client

credentials flow

Depending on the authentication mode that you selected, you must specify the details in the
following fields as applicable.
• Username: Enter the username that you want to use to access the mail server.

For example, john.smith@myCompanyName.com
• Password: Enter the password for the username you provided.
• For Client ID, Tenant ID, Redirect URI, and Client secret fields, enter the information

that is provided for your account on your Azure portal.
• Email provider: Select your email service provider from the drop-down list.

• Outlook/Office365
If you select this option, then provide the Tenant ID.

• Gmail

For Username, Password, Tenant ID, Client ID, and Client secret fields, choose from
Credential, Variable, or Insecure string tab:
• Credential: Use a value available in the credential vault.
• Variable: Use a user-defined variable that stores the values.
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• Insecure string: Manually enter a value.

• Se hai selezionato l'opzione EWS, compila i seguenti campi:
• Versione Exchange: seleziona la versione utilizzata dall'organizzazione:

• Exchange Server 2013
• Exchange2010_SP2
• Exchange2010_SP1
• Exchange2010
• Exchange2007_SP1

• Azure cloud: seleziona il prodotto utilizzato dall'organizzazione:
• Azure Globale: per i clienti di Microsoft 365 versione Commercial

(login.microsoftonline.com)
• Azure US GCC High: per i clienti di Microsoft 365 versione Government

(login.microsoftonline.us)

• Facoltativo: Nome del dominio:
• Se sei un cliente di Office 365 e lasci vuoto questo campo, RPA Workspace utilizza

smtp.office365.com per connettersi al server.
• Se sei un cliente di Office 365 e hai inserito un nome di dominio nel campo nome utente,

devi inserire smtp.office365.com in questo campo.
• Se non sei un cliente di Office 365, inserisci il nome del dominio della tua organizzazione. In

caso contrario, RPA Workspace utilizza il nome di dominio fornito nel campo Nome utente.

• Authentication mode: Choose from the following authentication modes:

Nota:  From Automation 360v.27 or later, the authorization type OAuth2-Silent
authentication mode is renamed to OAuth2-ROPC, and the OAuth2-Interactive
authentication mode is renamed to OAuth2-Implicit.

• Basic: Uses the username and password.
• OAuth2-ROPC: See Microsoft identity platform and OAuth 2.0 Resource Owner Password

Credentials
• OAuth2-Implicit: See Microsoft identity platform and implicit grant flow
• OAuth2 – Authorization code with PKCE: See Microsoft identity platform and OAuth 2.0

authorization code flow
• OAuth2 – Client credentials: See Microsoft identity platform and the OAuth 2.0 client

credentials flow

Depending on the authentication mode that you selected, you must specify the details in the
following fields as applicable.
• Username: Enter the username that you want to use to access the mail server.

For example, john.smith@myCompanyName.com
• Password: Enter the password for the username you provided.
• For Client ID, Tenant ID, Redirect URI, and Client secret fields, enter the information

that is provided for your account on your Azure portal.
• Test connection: Click Test connection to sign in to your account, accept the

permissions requested to authenticate, and establish a connection with the server.
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Nota:  When you perform desktop operation and click Test connection to sign in to your
account, then add this redirect URI: https://outlook.office365.com.

For Username, Password, Tenant ID, Client ID, and Client secret fields, choose from
Credential, Variable, or Insecure string tab:
• Credential: Use a value available in the credential vault.
• Variable: Use a user-defined variable that stores the values.
• Insecure string: Manually enter a value.

4. Fai clic su Salva.

Impostazioni del server di posta elettronica
I dettagli relativi al server di posta forniti quando stabilisci una connessione variano in base al server e-mail
a cui ti stai collegando.
The following table provides information about the host name and the port you must use when
establishing a connection to the specified mail server:

Server Per la lettura e il recupero
delle e-mail

Per l'invio di e-mail

Microsoft Outlook/Microsoft
Office 365

Host: outlook.office365.com
Porta: 993

Host: outlook.office365.com,
Porta: 993
Host:smtp.office365.com
Porta: 587

Gmail Host: imap.gmail.com
Porta: 993

Host: smtp.gmail.com
Porta: 587

Yahoo Host: imap.mail.yahoo.com
Porta: 993

Host: smtp.mail.yahoo.com
Porta: 465 o 587

MSN Host: imap-mail.outlook.com
Porta: 993
Per POP3:
Host: pop-mail.outlook.com
Porta: 993

Host: smtp-mail.outlook.com
Porta: 465 o 587

The Email package supports nonstandard ports in the range of 1 through 65535 for the SMTP server.

Additional configuration for Gmail and Yahoo

Se stai usando un account Gmail per automatizzare un'attività legata alla posta elettronica, assicurati che
l'opzione per consentire l'accesso alle app meno sicure sia abilitata e che IMAP sia abilitato per accedere a
Gmail da altri client che utilizzano IMAP . Questo è necessario per abilitare un TaskBot per l'invio di e-mail
utilizzando un account Gmail o Yahoo.
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To enable access for less secure apps:
1. Log in to your Gmail or Yahoo account.
2. Go to account settings.
3. Enable the option to allow less secure apps.

Nota:  You can use App password if the application does not support Sign in with Google to connect apps
to your Google Account. App passwords can only be used with accounts that have 2-Step Verification
turned on.
As a best practice, use OAuth 2.0 authentication to access G Suite account data.

Se stai usando un account Yahoo per automatizzare un'attività legata alla posta elettronica, assicurati di
generare la password dell'app dalla pagina di sicurezza dell'account Yahoo. Usa la password dell'app e
l'indirizzo e-mail per accedere al tuo account di posta elettronica.

Using the Forward action
Use the Forward action to forward emails and attachments to one or more recipients. To forward emails
as plain text or HTML through Exchange Web Services (EWS), Microsoft Outlook, or other email servers,
use this action within a Loop action.
To forward emails, follow these steps:
1. In the Actions palette, double-click or drag the Forward action from the Email package.
2. In the To address field and the optional Cc and Bcc fields, enter the email addresses of the

recipients.

Nota:  The To address, Cc, and Bcc fields are not case-sensitive.
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3. Opzionale: Per specificare se allegare più file come elenco o creare una variabile che contenga i valori
dell'elenco dell'oggetto file, seleziona la scheda Elenco o Variabile da Allegato.
Opzione Descrizione

Elenco • Seleziona l'allegato da una posizione:
• File Control Room: Enables you to select

an attachment that is available in a folder.
• Profilo desktop: Enables you to select

an attachment that is available on your
device.
Puoi fornire una combinazione di percorso
statico o di variabile stringa. Per usarlo
come variabile stringa, copia il percorso
statico dal desktop e crea una variabile di
tipo stringa. Inserisci il nome Variabile
e incolla il percorso del file nel campo
Valore predefinito. Premi F2 per inserire
il valore del percorso del file.

• Variabile: Enables you to specify the file
variable that contains the location of the
attachment.

• Specifica il percorso da allegare nel campo
Valore. Clicca su Aggiungi per allegare più
file.

Variabile Consente di specificare l'elenco degli oggetti file
contenenti la posizione degli allegati.
Crea una nuova variabile di tipo Elenco con
sottotipo File e aggiungi il percorso del file nel
campo Valore predefinito (opzionale). Puoi
scegliere il file dal Desktop o dalla Control
room.

When you are attaching multiple files to an email, to separate the file paths, if you are connected
with EWS, use a comma (,), and if you are connected to an email server or Microsoft Outlook, use a
semicolon (;).

4. Opzionale: Select the Raise error if attachments are missing (desktop only) check box to verify
that you have attached a file and the attached file exists.

Opzione Risultato

The Raise error if attachments are
missing (desktop only) check box is
selected

If a file is not attached, the email is not sent
and the bot encounters an error.

The Raise error if attachments are
missing (desktop only) check box is not
selected

The email is sent even if a file is not
attached.
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5. Seleziona il formato che desideri utilizzare tra le seguenti opzioni:
Opzione Descrizione

Testo semplice Utilizza un testo normale nel corpo dell'e-mail,
senza effetti di formattazione, come il grassetto,
il corsivo o il sottolineato, o opzioni di layout
speciali.

Codice HTML Utilizza lo script HTML nel corpo dell'e-mail se
vuoi che il contenuto venga visualizzato ogni
volta secondo un determinato layout. Puoi inoltre
includere elementi interattivi come i link.

Editor di design HTML Utilizza questa opzione per creare e
personalizzare il layout e il corpo dell'e-mail.
Usa la barra degli strumenti dell'editor per
apportare modifiche al testo, come applicare il
grassetto, il corsivo e altri effetti di formattazione,
inserire collegamenti e cambiare il carattere e
le dimensioni del testo. È possibile copiare il
contenuto dall'editor di design e incollarlo in altre
finestre.

6. Opzionale: Enter the content you want to send along with the email in the Message field.
The email will be appended to the message you have specified.

7. Opzionale: Select the Include Go Green message at the end of the email check box.
The Go Green message appends the following text to the bottom of the email body: Please
consider the environment before printing. Let's Go Green!
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8. Select the Email server, EWS or Outlook option from the Send email via list to specify whether to
send the emails using Microsoft Outlook or a mail server.
• Se hai selezionato l'opzione Outlook non sono necessari ulteriori dettagli.
• Se hai selezionato l'opzione Server e-mail, compila i seguenti campi:

Nota:  Per informazioni sugli host e le porte da utilizzare per i vari server di posta, vedi
Impostazioni del server di posta elettronica alla pagina 1502.

• Server host delle e-mail: immetti l'host che desideri connettere.

Nota:  Se utilizzi l'host Outlook.office365.com, è previsto un limite di 30 messaggi inviati al
minuto e 10.000 destinatari al giorno.

• Porta del server e-mail: immetti la porta che desideri utilizzare per stabilire la connessione.
• Usa connessione sicura (SSL/TLS): seleziona questa opzione se desideri utilizzare una

connessione sicura con il server di posta.
• Il mio server richiede l'autenticazione: Select this option if the server requires credentials

for access.
• Authentication mode: Select the authentication modes:

• Basic
• OAuth2 – Authorization code with PKCE

Depending on the authentication mode that you selected, you must specify the details in the
following fields as applicable.
• Username: Enter the username that you want to use to access the mail server.

For example, john.smith@myCompanyName.com
• Password: Enter the password for the username you provided.
• For Client ID, Tenant ID, Redirect URI, and Client secret fields, enter the information

that is provided for your account on your Azure portal.
• Email provider: Select your email service provider from the drop-down list.

• Outlook/Office365
If you select this option, then provide the Tenant ID.

• Gmail

For Username, Password, Tenant ID, Client ID, and Client secret fields, choose from
Credential, Variable, or Insecure string tab:
• Credential: Use a value available in the credential vault.
• Variable: Use a user-defined variable that stores the values.
• Insecure string: Manually enter a value.

• If you have selected the EWS option, you do not need to provide any additional details.

9. Fai clic su Salva.

Move all action
The Move all action in the Email package enables you to move all emails from one folder to another in the
email server.
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Impostazioni

• In the Session name field, enter the name of the session that you used to connect to the email server
in the Connect .

• Nel campo Percorso cartella di destinazione in cassetta postale, indica il percorso della posizione
nella quale desideri spostare l'e-mail.

• Seleziona quali e-mail spostare: Tutto, Letto o Non letto
• Nel campo Da una cartella specifica, specifica la cartella da cui spostare le e-mail. Ad esempio,

Posta in arrivo/project1.

Nota:  Per un server e-mail che utilizza il protocollo POP3 puoi recuperare le e-mail solo dalla posta in
arrivo.

• Facoltativo: specifica una delle seguenti condizioni:
• Quando l'oggetto contiene: immetti parole chiave separate da un punto e virgola.

How subject filter works when moving emails alla pagina 1520

Nota:  The When subject contains field is case sensitive. If you have established a connection
with the EWS server and when you enter text inside a pair of double quotation marks ("") in the
When subject contains field, the bot retrieves all the email messages whose subject exactly
matches the text and the case that you entered inside a pair of double quotation marks.

• Da specifici mittenti: immetti gli indirizzi e-mail dei mittenti separati da un punto e virgola.
• Quando la data di ricezione è uguale o successiva o Quando la data di ricezione è

precedente a: Seleziona una variabile data/ora dall'elenco.

Nota:  Poiché le cartelle non sono supportate in Gmail, questa action non è supportata per Gmail.

Nota:  Non puoi utilizzare l'action Sposta tutti all'interno di un loop. L'action Sposta tutti è progettata
per essere utilizzata con condizioni al di fuori di un loop.

Per ulteriori informazioni, vedi Can Move all action be used within a loop? (A-People login required)

Move action
The Move action in the Email package enables you to move an email from one folder to another in the
mailbox. Utilizza questa action all'interno di un'action Loop.

Impostazioni

• In the Session name field, enter the name of the session that you used to connect to the email server
in the Connect .

• In the Destination folder path in the mailbox field, provide the path to the destination folder
where you want to move the email. For example, Inbox/finance/1
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• Keep the following considerations in mind when you use the Move action:
• You must use this action inside a loop.
• When you connect with an Email server and use the IMAP protocol, ensure that you use the

Move action as the last action in the email loop.
• This action is not supported for POP3 connections.
• The bot encounters an error if the Delete action is used before the Move action.
• If you are connecting to Outlook, we recommend that you to use a Delay action after the Move

action. (Specify a maximum delay of more than 2 seconds). Delay is based on Outlook client
performance.

• For improved performance when moving a large number of emails, considering latency issues with
the Outlook client, we recommend using the Move all action instead of Move action when you
want to move more than 500 emails.

Using Reply action
Use the Reply action to send a response to an email with the same subject.
To send a reply to emails as plain text or HTML through Exchange Web Services (EWS), Microsoft Outlook,
or other email servers, use this action within a Loop action. This action does not include any files attached
to the original email.
Follow these to reply to an email:
1. In the Actions palette, double-click or drag the Reply action from the Email package.
2. In the Cc and Bcc fields, enter the email address of additional recipients.

Nota:  The Cc and Bcc fields are not case sensitive.

3. Opzionale: Per specificare se allegare più file come elenco o creare una variabile che contenga i valori
dell'elenco dell'oggetto file, seleziona la scheda Elenco o Variabile da Allegato.
Opzione Descrizione

Elenco • Seleziona l'allegato da una posizione:
• File Control Room: Enables you to select

an attachment that is available in a folder.
• Profilo desktop: Enables you to select

an attachment that is available on your
device.
Puoi fornire una combinazione di percorso
statico o di variabile stringa. Per usarlo
come variabile stringa, copia il percorso
statico dal desktop e crea una variabile di
tipo stringa. Inserisci il nome Variabile
e incolla il percorso del file nel campo
Valore predefinito. Premi F2 per inserire
il valore del percorso del file.

• Variabile: Enables you to specify the file
variable that contains the location of the
attachment.

• Specifica il percorso da allegare nel campo
Valore. Clicca su Aggiungi per allegare più
file.
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Opzione Descrizione

Variabile Consente di specificare l'elenco degli oggetti file
contenenti la posizione degli allegati.
Crea una nuova variabile di tipo Elenco con
sottotipo File e aggiungi il percorso del file nel
campo Valore predefinito (opzionale). Puoi
scegliere il file dal Desktop o dalla Control
room.

When you are attaching multiple files to an email, to separate the file paths, if you are connected
with EWS, use a comma (,), and if you are connected to an email server or Microsoft Outlook, use a
semicolon (;).

4. Opzionale: Select the Raise error if attachments are missing (desktop only) check box to verify
that you have attached a file and the attached file exists.

Opzione Risultato

The Raise error if attachments are
missing (desktop only) check box is
selected

If a file is not attached, the email is not sent
and the bot encounters an error.

The Raise error if attachments are
missing (desktop only) check box is not
selected

The email is sent even if a file is not
attached.

5. Seleziona il formato che desideri utilizzare tra le seguenti opzioni:
Opzione Descrizione

Testo semplice Utilizza un testo normale nel corpo dell'e-mail,
senza effetti di formattazione, come il grassetto,
il corsivo o il sottolineato, o opzioni di layout
speciali.

Codice HTML Utilizza lo script HTML nel corpo dell'e-mail se
vuoi che il contenuto venga visualizzato ogni
volta secondo un determinato layout. Puoi inoltre
includere elementi interattivi come i link.

Editor di design HTML Utilizza questa opzione per creare e
personalizzare il layout e il corpo dell'e-mail.
Usa la barra degli strumenti dell'editor per
apportare modifiche al testo, come applicare il
grassetto, il corsivo e altri effetti di formattazione,
inserire collegamenti e cambiare il carattere e
le dimensioni del testo. È possibile copiare il
contenuto dall'editor di design e incollarlo in altre
finestre.

6. Enter the content you want to send along with the email in the Message field.
The email will be appended to the message you have specified.

7. Opzionale: Select the Include Go Green message at the end of the email check box.
The Go Green message appends the following text to the bottom of the email body: Please
consider the environment before printing. Let's Go Green!
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8. Select the Email server, EWS or Outlook option from the Send email via list to specify whether to
send the emails using Microsoft Outlook or a mail server.
• Se hai selezionato l'opzione Outlook non sono necessari ulteriori dettagli.
• Se hai selezionato l'opzione Server e-mail, compila i seguenti campi:

Nota:  Per informazioni sugli host e le porte da utilizzare per i vari server di posta, vedi
Impostazioni del server di posta elettronica alla pagina 1502.

• Server host delle e-mail: immetti l'host che desideri connettere.

Nota:  Se utilizzi l'host Outlook.office365.com, è previsto un limite di 30 messaggi inviati al
minuto e 10.000 destinatari al giorno.

• Porta del server e-mail: immetti la porta che desideri utilizzare per stabilire la connessione.
• Usa connessione sicura (SSL/TLS): seleziona questa opzione se desideri utilizzare una

connessione sicura con il server di posta.
• Il mio server richiede l'autenticazione: Select this option if the server requires credentials

for access.
• Authentication mode: Select the authentication modes:

• Basic
• OAuth2 – Authorization code with PKCE

Depending on the authentication mode that you selected, you must specify the details in the
following fields as applicable.
• Username: Enter the username that you want to use to access the mail server.

For example, john.smith@myCompanyName.com
• Password: Enter the password for the username you provided.
• For Client ID, Tenant ID, Redirect URI, and Client secret fields, enter the information

that is provided for your account on your Azure portal.
• Email provider: Select your email service provider from the drop-down list.

• Outlook/Office365
If you select this option, then provide the Tenant ID.

• Gmail

For Username, Password, Tenant ID, Client ID, and Client secret fields, choose from
Credential, Variable, or Insecure string tab:
• Credential: Use a value available in the credential vault.
• Variable: Use a user-defined variable that stores the values.
• Insecure string: Manually enter a value.

• If you have selected the EWS option, you do not need to provide any additional details.

9. Fai clic su Salva.

Save all attachments action
Use the Save all attachments action to save attachments from all emails on the email server to a
specified folder.
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Impostazioni

• In the Session name field, enter the name of the session that you used to connect to the email server
in the Connect .

• Seleziona le e-mail da salvare: Tutto, Letto o Non letto.
• Nel campo Salva allegati in una cartella, specifica la posizione in cui salvare gli allegati.

Nota:  Questo campo non è sensibile alla distinzione tra maiuscole/minuscole.

• Overwrite file(s): Select this option to overwrite an existing file with the same name. Se questa
opzione non è selezionata, l'allegato scaricato viene salvato con lo stesso nome file che presenta
suffisso con un valore numerico; non sovrascrive il file esistente.

Nota:
• Puoi salvare gli allegati con un nome file che contiene un carattere TAB.
• Se sei connesso a un server Outlook, le immagini incorporate nelle e-mail vengono scaricate insieme

agli allegati.

Save attachment action
Use the Save attachment action to save attachments from one email to a specified folder. Utilizza questa
action all'interno di un'action Loop.

Impostazioni

• Nel campo Salva allegati in una cartella, specifica la posizione in cui salvare gli allegati.

Nota:  Questo campo non è sensibile alla distinzione tra maiuscole/minuscole.

• Overwrite file(s): Select this option to overwrite an existing file with the same name. Se questa
opzione non è selezionata, l'allegato scaricato viene salvato con lo stesso nome file che presenta
suffisso con un valore numerico; non sovrascrive il file esistente.

Nota:  Se sei connesso a un server Outlook, le immagini incorporate nelle e-mail vengono scaricate
insieme agli allegati.

Save email action
Use the Save email action in the Email package to save an email message as an EML file to a folder.
Utilizza questa action all'interno di un'action Loop.

Impostazioni

• In the Session name field, enter the name of the session that you used to connect to the email server
in the Connect .

• Nel campo Salva messaggi in una cartella, specifica la posizione in cui salvare il messaggio.

Nota:  Questo campo non è sensibile alla distinzione tra maiuscole/minuscole.
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• Sovrascrivi file: seleziona questa opzione per sovrascrivere il file esistente con lo stesso nome. If
this option is not selected, the email message is saved with the same filename suffixed with a numeric
value; it does not overwrite the existing file.

Nota:  Microsoft Outlook supports this action.

Utilizzo di Invia action
Utilizza Invia action per inviare un'e-mail. Questa action consente di inviare un'e-mail a uno o più
destinatari da Microsoft Outlook o da un server di posta, allegare file e scegliere di inviare l'e-mail in
formato testo normale o HTML.
Invia action consente di allegare a un'e-mail più file di vari formati. Non esiste alcuna limitazione sul tipo
di file che è possibile allegare. Si applicano tuttavia le limitazioni previste dal server di posta utilizzato per
inviare le e-mail. Ad esempio, un'attività non sarà completata correttamente se i file allegati all'e-mail che
stai inviando non rispettino le limitazioni previste dal server di posta.

Nota:  Gli allegati inviati nell'ambito dell'automazione delle e-mail sono soggetti alle politiche e alle regole
impostate a livello di server proxy, firewall, antivirus, server e-mail, ambiente del cliente e così via.

Per inviare un'e-mail da un account Gmail o Yahoo, abilita l'accesso a un'app meno sicura per l'account in
questione. Consulta Impostazioni del server di posta elettronica alla pagina 1502.
1. Nella tavolozza Actions, fai doppio clic o trascina l'action Invia dal package Email.
2. In the To address field and the optional Cc and Bcc fields, enter the email addresses of the

recipients.

Nota:  The To address, Cc, and Bcc fields are not case-sensitive.

3. Nel campo Oggetto, immetti l'oggetto dell'e-mail.
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4. Opzionale: Per specificare se allegare più file come elenco o creare una variabile che contenga i valori
dell'elenco dell'oggetto file, seleziona la scheda Elenco o Variabile da Allegato.

Nota:  Quando crei un bot, se l'allegato include il simbolo minore di (<) come carattere speciale
nel percorso del file, il carattere speciale verrà rimosso dopo l'esecuzione del bot perché il sistema
operativo Windows non supporta questo carattere speciale.

Opzione Descrizione

Elenco • Seleziona l'allegato da una posizione:
• File Control Room: Enables you to select

an attachment that is available in a folder.
• Profilo desktop: Enables you to select

an attachment that is available on your
device.
Puoi fornire una combinazione di percorso
statico o di variabile stringa. Per usarlo
come variabile stringa, copia il percorso
statico dal desktop e crea una variabile di
tipo stringa. Inserisci il nome Variabile
e incolla il percorso del file nel campo
Valore predefinito. Premi F2 per inserire
il valore del percorso del file.

• Variabile: Enables you to specify the file
variable that contains the location of the
attachment.

• Specifica il percorso da allegare nel campo
Valore. Clicca su Aggiungi per allegare più
file.

Variabile Consente di specificare l'elenco degli oggetti file
contenenti la posizione degli allegati.
Crea una nuova variabile di tipo Elenco con
sottotipo File e aggiungi il percorso del file nel
campo Valore predefinito (opzionale). Puoi
scegliere il file dal Desktop o dalla Control
room.

5. Opzionale: Select the Raise error if attachments are missing (desktop only) check box to verify
that you have attached a file and the attached file exists.

Opzione Risultato

The Raise error if attachments are
missing (desktop only) check box is
selected

If a file is not attached, the email is not sent
and the bot encounters an error.

The Raise error if attachments are
missing (desktop only) check box is not
selected

The email is sent even if a file is not
attached.
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6. Seleziona il formato che desideri utilizzare tra le seguenti opzioni:
Opzione Descrizione

Testo semplice Utilizza un testo normale nel corpo dell'e-mail,
senza effetti di formattazione, come il grassetto,
il corsivo o il sottolineato, o opzioni di layout
speciali.

Codice HTML Utilizza lo script HTML nel corpo dell'e-mail se
vuoi che il contenuto venga visualizzato ogni
volta secondo un determinato layout. Puoi inoltre
includere elementi interattivi come i link.

Editor di design HTML Utilizza questa opzione per creare e
personalizzare il layout e il corpo dell'e-mail.
Usa la barra degli strumenti dell'editor per
apportare modifiche al testo, come applicare il
grassetto, il corsivo e altri effetti di formattazione,
inserire collegamenti e cambiare il carattere e
le dimensioni del testo. È possibile copiare il
contenuto dall'editor di design e incollarlo in altre
finestre.

7. Enter the content you want to send along with the email in the Message field.
The email will be appended to the message you have specified.

8. Opzionale: Select the Include Go Green message at the end of the email check box.
The Go Green message appends the following text to the bottom of the email body: Please
consider the environment before printing. Let's Go Green!
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9. Seleziona l'opzione Server e-mail, EWS o Outlook dall'elenco Invia e-mail via per specificare se
inoltrare le e-mail utilizzando Exchange Web Services (EWS), Microsoft Outlook o un server di posta.
• Se hai selezionato l'opzione Outlook non devi fornire ulteriori dettagli.

Nota:  Multiple accounts are not supported on the local system. Set up only one account to access
mails using bots.

• Email server: For information about the host and port to be used for the various mail servers, see
Impostazioni del server di posta elettronica alla pagina 1502.
• From address Enter the email address.

Nota:  If the mail server does not support sending an email using an alias email address, use
the same email ID in the From address as provided in the Username field while configuring
the mail server.

• Use secure connection (SSL/TLS): Select True or False, or insert a Boolean variable.
• Email server host: Enter the host you want to connect.

Nota:  If you use the host Outlook.office365.com, there is a limit of 30 messages sent per
minute and 10,000 recipients per day.

• Email server port: Enter the port you want to use to establish the connection.
• My server requires authentication: Select True or False, or insert a Boolean variable.
• Authentication mode: Select the authentication type:

• Basic
• OAuth2 – Authorization code with PKCE

Depending on the authentication mode that you selected, you must specify the details in the
following fields as applicable.
• Username: Enter the username that you want to use to access the mail server.

For example, john.smith@myCompanyName.com
• Password: Enter the password for the username you provided.
• For Client ID, Tenant ID, Redirect URI, and Client secret fields, enter the information that

is provided for your account on your Azure portal.
• Email provider: Select your email service provider from the drop-down list.

• Outlook/Office365
If you select this option, then provide the Tenant ID.

• Gmail

For Username, Password, Tenant ID, Client ID, and Client secret fields, choose from
Credential, Variable, or Insecure string tab:
• Credential: Use a value available in the credential vault.
• Variable: Use a user-defined variable that stores the values.
• Insecure string: Manually enter a value.

• EWS Server:
• Exchange Version: Select the version that your organization is using:

• Exchange Server 2013
• Exchange2010_SP2
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• Exchange2010_SP1
• Exchange2010
• Exchange2007_SP1

• Azure cloud: Select the product that your organization is using:
• Azure Global: For customers of Microsoft 365 Commercial version

(login.microsoftonline.com)
• Azure US GCC High: For customers of Microsoft 365 Government version

(login.microsoftonline.us)

• Optional: Domain name:
• If you are an Office 365 customer and you leave this field blank, RPA Workspace uses

smtp.office365.com to connect to the server.
• If you are an Office 365 customer and you have entered a domain name in the username

field, you must enter smtp.office365.com in this field.
• If you are not an Office 365 customer, enter the domain name of your organization.

Otherwise, RPA Workspace uses the domain name you provided in the Username field.

• Authentication mode: Select the authentication types:

Nota:  From Automation 360 v.27 or later, the authorization type OAuth2-Silent
authentication mode is renamed to OAuth2-ROPC, and the OAuth2-Interactive
authentication mode is renamed to OAuth2-Implicit.

• Basic
• OAuth2-ROPC
• OAuth2-Implicit
• OAuth2 – Authorization code with PKCE
• OAuth2 – Client credentials

Depending on the authentication mode that you selected, you must specify the details in the
following fields as applicable.
• Username: Enter the username that you want to use to access the mail server.

For example, john.smith@myCompanyName.com
• Password: Enter the password for the username you provided.
• For Client ID, Tenant ID, Redirect URI, and Client secret fields, enter the information that

is provided for your account on your Azure portal.
• Test connection: Click Test connection to sign in to your account, accept the permissions

requested to authenticate, and establish a connection with the server.

Nota:  When you perform desktop operation and click Test connection to sign in to your
account, then add this redirect URI: https://outlook.office365.com.

For Username, Password, Tenant ID, Client ID, and Client secret fields, choose from
Credential, Variable, or Insecure string tab:
• Credential: Use a value available in the credential vault.
• Variable: Use a user-defined variable that stores the values.
• Insecure string: Manually enter a value.
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10. Fai clic su Salva.

Using the For each mail in mail box iterator
È necessario utilizzare determinate actions E-mail all'interno dell'action Loop. Utilizza l'iteratore Per
ogni e-mail nella casella di posta per ripetere una serie di actions su tutte le e-mail che rientrano in
parametri specifici.
First, connect to the email server. Using Connect action for Email alla pagina 1497
When you establish a connection with Microsoft Outlook, email messages are processed from the shared
mailbox. Ensure that you have set up the shared mailbox in your Outlook application.

Nota:  This feature is supported only for Outlook.

You must use the following Email actions within a loop:
• Cambia stato
• Elimina
• Salva gli allegati
• Salva messaggio

Le e-mail vengono recuperate in base alla sequenza delle cartelle elencate nel campo della posta in arrivo.
All'interno di ogni cartella, le e-mail vengono recuperate in base alla data e all'ora di ricezione nell'ultimo
ordine in entrata e del primo in uscita (LIFO). Inoltre, puoi applicare filtri ai seguenti campi:
• Tipi di e-mail: Tutto, Letto e Non letto
• Oggetto
• Da una cartella specifica
• Per specifico mittente
• Prima, dopo o nella data di ricezione

To use an Email action within a loop, follow these steps:
1. Fai doppio clic o trascina l'action Loop dal package Loop nella tavolozza Actions.
2. Seleziona l'opzione Per ogni e-mail nella casella di posta dall'elenco Iteratore.
3. In the Session name field, enter the name of the session that you used to connect to the email

server in the Connect action.
4. Nelle opzioni TUTTI, LETTO o NON LETTO, specifica il tipo di e-mail da recuperare dal server e-mail.

Nota:  For an email server that uses the POP3 protocol, all emails are retrieved.
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5. Opzionale: Specify the folder from which you want to retrieve the emails.
• Microsoft Outlook e Yahoo: You can specify the name of the folder.

Ad esempio, Posta in arrivo, Inviata, Posta in arrivo/Vendite, Posta in
 arrivo/IT e così via. Le cartelle Vendite e IT in questo esempio sono cartelle create
dall'utente e non sono disponibili per impostazione predefinita.

• Gmail:
• To retrieve emails from the default folders, you must use [Gmail]/FOLDER, except for the

Inbox folder.
Ad esempio, [Gmail]/Bozze, [Gmail]/Mail importanti, [Gmail]/Cestino e così via.

• Per recuperare le e-mail dalle cartelle create o dalla cartella Posta in arrivo, è necessario
specificare i nomi delle cartelle così come sono.
Ad esempio, se hai creato cartelle denominate Banca e Sport nella tua Gmail, specifica Banca
e Sport senza il prefisso [Gmail] per recuperare le e-mail da queste cartelle.

6. Opzionale: Nel campo Quando l'oggetto contiene, specifica un valore per recuperare le e-mail che
contengono il valore specificato nell'oggetto.
You can enter multiple text separated by semi-colon. When you specify multiple text separated
by semi-colon, the emails are retrieved with any text or combination of text. For example,
[Subject]=[Automation Anywhere]: The filter searches and retrieves emails where subject text
includes Automation or Automation Anywhere.
To know about the behavior of the subject filter for package version 3.13.1-20220713-173156 and
later using Microsoft Outlook server or Email server, see How subject filter works when moving emails.

7. Opzionale: Nel campo Da mittenti specifici, specifica gli indirizzi e-mail per recuperare le e-mail.
8. Opzionale: Nell'elenco Quando la data di ricezione è il o dopo, seleziona un'opzione per

recuperare solo e-mail specifiche ricevute in o dopo una determinata data.
9. Opzionale: Nell'elenco Quando la data di ricezione è il o prima, seleziona un'opzione per

recuperare solo e-mail specifiche ricevute in o prima di una determinata data.
If you have specified values for Steps 6 through 9, the system retrieves only those emails that
meet all the criteria. Per esempio, se si specifica Banca nel passaggio 5, Estratto conto nel
passaggio 6 e abcbank@xyz.com nel passaggio 7, il sistema recupererà le e-mail dalla cartella
Banca che contengono Estratto conto nell'oggetto e sono state ricevute dall'indirizzo e-mail
abcbank@xyz.com.

10. Scegli una delle seguenti opzioni da Usa il fuso orario locale
• Vero: La data e l'ora di ricezione dell'e-mail vengono visualizzate nel fuso orario locale.
• Falso: La data e l'ora di ricezione dell'e-mail vengono visualizzate nel fuso orario UTC.
• Variabile: Inserisci una variabile booleana.

11. Opzionale: Nell'elenco Assegna il valore corrente alla variabile, seleziona o crea una variabile
dizionario.
La variabile dizionario memorizza le proprietà di ogni e-mail. . Using dictionary variable for email
properties alla pagina 1519.

12. Fai clic su Salva.

Inserisci un'action Finestra di messaggio nel contenitore Loop per stampare l'oggetto di ogni e-mail.
Utilizza il corpo del messaggio seguente, sostituendo il nome della variabile generica con quello utilizzato
nel passaggio 10: $dictionaryVar{emailSubject}$
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Using dictionary variable for email properties
When you automate an email-related task, RPA Workspace retrieves various properties of an email and
stores the values of these properties in a dictionary variable. These properties are stored in a dictionary
variable when you use an email action within a loop action.
Some of the email properties that RPA Workspace retrieves are its subject, recipients, senders, message,
and received date and time. The email properties are stored in a dictionary variable within the following
dictionary keys:

Email property Tipo di dati Descrizione

emailSubject Stringa Retrieves the value of the email
subject.

emailFrom Stringa Retrieves the email ID which
is received from. The from
address is what your recipients
will see.

emailTo Stringa Retrieves the recipient's email
ID.

emailCc Stringa Retrieves the recipient mail id
from the CC list.

emailBcc Stringa Retrieves the recipient mail id
from the BCC list.

emailMessage Stringa Retrieves the text from the
email body.

emailReceivedTime Stringa Retrieves the time when the
email was received.

emailReceivedDate Stringa Retrieves the date when the
email was received.

emailSentTime Stringa Retrieves the time when the
email was sent.

emailSentDate Stringa Retrieves the date when the
email was sent.

Nota:  The email received and sent date and time are retrieved in the following format:
• Date: dd/MM/yyyy HH:mm:ss

Sample output: 22/09/2022 17:07:13
• Time: HH:mm:ss Z

Sample output: 17:07:13 +0900

The system automatically associates the properties of an email with the appropriate dictionary keys. You
can use the values stored in these dictionary keys in another task, store them in a database, or for any
other purpose. These keys are available in the system and you must use them as specified above. For
example, if you have created a dictionary variable 'Test' and want to display the subject and sender of
an email in a message prompt, you must enter Test{emailSubject} and Test{emailFrom} in the
appropriate fields.
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If you press F2 to use a variable in a field, you must select Test from the Choose a variable list and
enter emailSubject in the Dictionary key field in the Insert a variable dialog box to store the
subject of an email in that field. Similarly, you can enter emailFrom in the Dictionary key field to use
the email address of the sender of an email in a field.
The dictionary key variable is required for all email-related tasks you automate from Microsoft Outlook and
any mail server if you want to use the email properties. La variabile del dizionario può essere utilizzata per
le seguenti azioni E-mail:
• Cambia stato
• Elimina
• Inoltra
• Rispondi
• Salva gli allegati
• Salva messaggio

Nota:  The time required to save an email varies based on the size of the attachments available in that
email.

How subject filter works when moving emails
In the Move allaction and the Loop action in the Email package, learn how the subject filter works in
order to move your emails from one folder to another in the email or Microsoft Outlook server.
You can use the keywords in the email subject field to filter emails. If keywords are added within quotes ,
the bot will look for an exact match of keywords in the subject field to filter and retrieve emails.

Outlook server

The following table explains how the subject filter works when the subject field contains single, multiple
texts, or multiple subjects separated by semi-colon.
• Single text

Risultato Esempio

With double quotes: Retrieves emails with
the exact subject text and is case-sensitive.

Esempio: [Subject]=["Automation"]:
The filter retrieves emails where the subject
text includes “Automation” as an exact word.

Without double quotes: Retrieves emails
that have the similar text and is not case-
sensitive.

Esempio: [Subject]=[Automation]: The
filter searches and retrieves emails where the
subject text includes Automation.

• Multiple text

Risultato Esempio

With double quotes: Retrieves emails with
the exact subject text and is case-sensitive.

Esempio: [Subject]=["Automation
 Anywhere"]: The filter retrieves emails
where subject text includes “Automation
Anywhere” as an exact phrase.

Without double quotes: Retrieve emails
with any text or combination of text and is
not case-sensitive.

Esempio: [Subject]=[Automation
 Anywhere]: The filter searches and
retrieves emails where subject text includes
Automation or Automation Anywhere.
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• Multiple subjects separated by semi-colon

Risultato Esempio

With double quotes:Retrieves emails with
the complete subject line that is an exact
match including the semicolon and double
quotation marks.

Esempio: [Subject 1] =["Delivery
 Failure"];[Subject 2] =["Mail
 server not found"], separated by a
semicolon.
The filter retrieves emails with the subject
line as one string that is an exact match with
the semicolon, such as “Delivery Failure ; Mail
server not found”.

Without double quotes: Retrieve emails
with the complete subject line including the
semicolon.

Esempio: [Subject 1]= ["Delivery
 Failure"];[Subject 2]= ["Mail
 server not found"], separated by a
semicolon.
The filter retrieves emails with the subject
line that includes text as one string with the
semicolon but is not an exact match, such
as: Delivery Failure ; Mail server not found or
delivery failure ; mail server not found.

Some with double quotes and some
without double quotes: Retrieve emails
with the complete subject line that is an exact
match including the semicolon.

Esempio: [Subject 1]= [Delivery
 Failure];[Subject 2]= ["Mail
 server not found"], separated by a
semicolon.
The filter retrieves emails with the subject
line as one string that is an exact match with
the semicolon, such as: Delivery Failure ; Mail
server not found.

Server e-mail

The following table explains how the subject filter works when the subject field contains single, multiple
texts, or multiple subjects separated by semi-colon.
• Single text

Risultato Esempio

With double quotes: Retrieves emails with
the exact subject text and is case-sensitive.

Esempio: [Subject]=["Automation"]:
The filter retrieves emails where the subject
text includes “Automation” as an exact word.

Without double quotes: Retrieves emails
that have the similar text and is not case-
sensitive.

Esempio: [Subject]=[Automation]: The
filter searches and retrieves emails where the
subject text includes Automation.
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• Multiple text

Risultato Esempio

With double quotes: Retrieves emails with
the exact subject text and is case-sensitive.

Esempio: [Subject]=["Automation
 Anywhere"]: The filter retrieves emails
where subject text includes “Automation
Anywhere” as an exact phrase.

Without double quotes: Retrieve emails
with any text or combination of text and is
not case-sensitive.

Esempio: [Subject]=[Automation
 Anywhere]: The filter searches and
retrieves emails where subject text includes
Automation or Automation Anywhere.

• Multiple subjects separated by semi-colon

Risultato Esempio

With double quotes:Retrieve emails for
each subject that is an exact match and is
case-sensitive.

Example: [Subject 1] =["Delivery
 Failure"];[Subject 2] =["Mail
 server not found"]

Individual subjects separated by a semicolon
with an exact match are searched. The
filter retrieves emails with the subject line
“Delivery Failure” and/or “Mail server not
found”.

Without double quotes: Retrieve emails for
each subject and is not case-sensitive.

Example: [Subject 1]= [Delivery
 Failure];[Subject 2]= [Mail
 server not found]

The filter retrieves emails that include the
subject line with text as Delivery Failure or
Mail server not found.

Some with double quotes and some
without double quotes: Retrieve emails
for each subject. Subjects within double
quotation marks are an exact match. Subjects
without double quotes are not case-sensitive.

Example: [Subject 1]= [Delivery
 Failure];[Subject 2] = ["Mail
 server not found"]

• For Subject 1, the filter searches and
retrieves emails that include the text in the
subject line.

• For Subject 2, the filter searches and
retrieve emails with the exact text in the
subject line.

Server EWS

The following table explains how the subject filter works when the subject field contains single or multiple
texts with, or without, double quotes.
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Oggetto dell'e-mail

Searched
with
keywords

move
email

move
email
(Include
space)

Move
email

"move
email"

"Move
email"

" move
email" (Include
space)

" Move
email" (Include
space)

move
email
test

sposta email

move
email

Sì Sì Sì Sì Sì Sì Sì Sì - -

move
email

- - - - - Sì Sì - - -

Move
email

Sì Sì Sì Sì Sì Sì Sì Sì - -

"move
email"

Sì Sì - Sì - Sì - Sì - -

"Move
email"

- - Sì - Sì - Sì - - -

" move
email"

- - - - - Sì - - - -

" Move
email"

- - - - - - Sì - - -

move
email
test

- - - - - - - Sì - -

sposta Sì Sì Sì Sì Sì Sì Sì Sì Sì -

email Sì Sì Sì Sì Sì Sì Sì Sì - Sì

email" - - - Sì Sì Sì Sì - - -

"move - - - Sì Sì - - - - -

Nota:
• When you search with keywords such as move email, Move email, or move, the bot will look for the

keywords in the Subject field to filter and retrieve emails.
• When you search with keywords inside a pair of double quotation marks in the Subject field such as

"Move email", "Move email", "move, or email", the bot will look for an exact match of keywords
and is case-sensitive to filter and retrieve emails.

Error handler package
Se un bot rileva un errore dovuto a una condizione anomala o a eccezioni durante l'esecuzione, la normale
esecuzione del bot è ostacolata e il bot non riesce a completare l'attività. Il package Error handler contiene
actions che consentono di gestire facilmente le eccezioni che un bot incontra trasferendo il controllo alle
altre actions all'interno di tale bot.
Le actions nel package consentono di separare le actions che desideri utilizzare per eseguire un'attività
dalle actions da utilizzare per gestire un'eccezione. La gestione delle eccezioni assicura che un bot completi
un'attività quando rileva un errore e definisce le actions quando si verifica un errore.
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L'immagine seguente illustra come funziona l'esecuzione del bot quando si usa e non si usa la gestione
degli errori nella propria attività.

Actions nel package Error handler

Il package Error handler include le seguenti actions:

Azione Descrizione

Prova Consulta Try action in Error handler alla pagina 1525.

Cattura Consulta Catch action in Error handler alla pagina 1526.

Infine Consulta Finally action in Error handler alla pagina 1526.

Lancia Consulta Throw action in Error handler alla pagina 1526.

Come Error handler gestisce le eccezioni

L'immagine seguente illustra il flusso di actions del package Error handler quando si riscontra un errore
esterno durante l'esecuzione di un bot.

L'immagine seguente illustra il flusso di actions del package Error handler quando si riscontra un errore
interno durante l'esecuzione di un bot.
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Esempio: Using the actions in the Error handler package

In questo esempio, si dispone di un bot che legge i dati da un file Microsoft Excel e li archivia in un
database. The bot might encounter an error if the required file is not available or while updating a table in
the database. Use the following methods to handle the errors:
• Exception 1:

• The Microsoft Excel spreadsheet from which you want to extract data is not available.
• Come gestire: Use another file that contains the same data.

• Exception 2:
• The table that you want to use to store the data is not available in the database.
• Come gestire: Display a message that the required table is not available.

Based on this example, perform the following to handle the mentioned exceptions:
1. Inserisci tutte le actions che servono per leggere i dati dal foglio di calcolo Microsoft Excel e archiviare

i dati estratti in una tabella nel database all'interno dell'action Prova.
2. Inserisci le actions da eseguire per le seguenti eccezioni all'interno dell'action Cattura:

a. Exception 1: Inserisci le actions per utilizzare il file alternativo che contiene gli stessi dati.
b. Exception 2: Inserisci l'action Finestra di messaggio per visualizzare un messaggio pertinente.

3. Inserisci l'action Database > Disconnetti per terminare la connessione con il database all'interno
dell'action Infine che si verifica indipendentemente dal risultato di Prova.

Try action in Error handler
Use the Try action in the Error handler package to allow you to add actions for the bot to execute these
actions as usual.

Impostazioni

Se il bot non rileva errori, l'esecuzione continua fino all'action Infine, se esistente. Tuttavia, se si verifica
un errore, l'esecuzione del bot passa direttamente all'action Cattura e non completerà il resto delle actions
all'interno dell'action Prova.
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Catch action in Error handler
Use the Catch action in the Error handler package to take control of the bot execution when an error
occurs within a Try action.

Impostazioni

È possibile assegnare i valori per la descrizione dell'errore e il numero di riga a variabili all'interno
dell'action Cattura. È possibile aggiungere ulteriori actions all'interno dell'action Cattura per gestire la
condizione di errore. Queste actions possono includere un'action Email Invia (invio di un'e-mail su errore),
un'action Registra nel file (registrazione della condizione di errore in un file) o un Screen Acquisisci la
finestra per acquisire uno screenshot della finestra o dell'applicazione quando si verifica l'errore.
Se l'action Cattura non è presente, l'action Prova, al verificarsi di un errore, continuerà l'elaborazione
delle actions elencate dopo l'action Prova.
È possibile utilizzare le actions Prova e Cattura più volte in un bot per gestire varie eccezioni. This
enables you to run a different set of actions based on the exception encountered.
You can now ignore errors from actions inside the Catch block by using the Catch > On error, continue
with next action option. When you select the On error, continue with next action check box, even
if there is an error from an action in the Catch block, no exception is thrown and the bot ignores the error
and continues to the next action.

Nota:  Questo miglioramento si applica a tutte le actions contenute all'interno del blocco Cattura. Per
esempio, se esiste un'action Prova/Cattura all'interno dell'action Cattura principale e la casella di
controllo dell'action Cattura principale è selezionata, qualsiasi errore da actions all'interno del blocco
annidato sarà ignorato.

Finally action in Error handler
Use the Finally action in the Error handler package to enable you to execute actions after Try and Catch,
regardless of whether an exception occurs or not.

Impostazioni

L'action Infine è molto utile per registrare le informazioni di audit o qualsiasi action che deve seguire la
fine delle actions Prova e Cattura.

Throw action in Error handler
Use the Throw action in the Error handler package to create an error condition, which will immediately
shift the bot execution to the Catch action.

Impostazioni

Se si verifica un errore logico all'interno di un'action Prova, è possibile utilizzare l'action Lancia per
creare una condizione di errore che sposterà immediatamente l'esecuzione del bot all'action Cattura. È
possibile modificare le proprietà dell'action Lancia per impostare il messaggio di errore da inviare all'action
Cattura. Fuori da un'action Prova, l'action Lancia causa la visualizzazione di una finestra di dialogo di
errore standard, richiedendo all'utente di fare clic manualmente sul tasto Chiudi per chiuderla.
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Excel basic package
The Excel basic package contains actions that enable you to automate many of the repetitive tasks in XLSX
workbooks. You use these actions when Microsoft Excel is not available on the device that you want to use
to automate Microsoft Excel-related tasks.

Nota:  The XLS and CSV formats are not supported and you cannot set a value in the XFD column of a
spreadsheet.

Important:  If you use different versions of the Excel basic package in a parent bot and a child bot, the
capability to share a session across bots is currently not supported. To share a session across parent and
child bots, ensure that you use the same version of the package in both the parent and child bots.

Importante:  When you use Microsoft Excel Version 2208 and a bot tries to open an unprotected macro,
a security warning is displayed indicating that the macros are blocked as they are not from a trusted
source.
Per maggiori dettagli, consulta Macros from the internet will be blocked by default in Office.

Choosing the Excel package in Automation 360

Automation 360 includes packages to support three types of Microsoft Excel usage. For optimal results, use
the package that corresponds to the type of Excel that is available on the device you are running bots on.
• Nessun Excel installato: If you do not have Microsoft Excel installed on the device on which you are

running bots to automate Excel-related processes, use the Excel basic package.
• Installata la versione desktop di Excel: If you have a desktop version of Microsoft Excel installed

on your computer, use the Excel advanced package in your bots.
• Solo Office 365 Excel online: If you are using Microsoft Excel 365 on a web browser, use the Office

365 Excel package for automating tasks related to Excel.

Recommendation:  For any bot automation use case that cannot be fulfilled by the Excel basic package,
we recommend that you use the Excel advanced package. When you use that Excel basic package, you
might experience limitations because of the Apache POI API that the package uses. Because of this, the
Excel basic package has limited capability when compared to the Excel advanced package that uses the MS
API.

To learn more, search for the Automating Excel Workbooks course in Automation Anywhere University: RPA
Training and Certification (A-People login required).

Prima di iniziare

Esegui le seguenti actions contenute nel package Excel basic come parte integrante dell'utilizzo del set di
actions disponibili:
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1. Open the Microsoft Excel spreadsheet that you want to read data from using the Open action.

Nota:  The Excel basic package supports files that are a maximum size of 30 MB.

You must associate the details of the file you want to use with a session name, and use the session
name in the other actions in the Excel basic package, so that you do not have to provide the details of
the file in those actions again.

2. Use the different actions available in the Excel basic package to automate the Microsoft Excel-related
tasks.

3. Dopo aver automatizzato tutte le attività correlate a Microsoft Excel, chiudi il foglio di calcolo
utilizzando l'action Chiudi.

Actions nel package Excel basic

Il package Excel basic include le seguenti actions:

Action Descrizione

Chiudi Consulta Close action alla pagina 1529.

Elimina celle .
Consulta Delete cells action alla pagina 1529.

Trova Consulta Using Find action in Excel alla pagina 1553.

Ottieni indirizzo di cella Consulta Get cell address action alla pagina 1530.

Ottieni nome colonna Consulta Get column name action alla pagina 1530.

Ottieni più celle
Consulta Get multiple cells action alla pagina 1529.

Ottieni numero di riga Consulta Get row number action alla pagina 1531.

Ottieni cella singola
.
Consulta Get single cell action alla pagina 1530.

Vai alla cella .
Consulta Go to cell action alla pagina 1531.

Apri See Using the Open action.

Replace Consulta Using the Replace action alla pagina 1557.

Salva cartella di lavoro Consulta Save workbook action alla pagina 1532.

Imposta cella Consulta Set cell action alla pagina 1532.

Passa al foglio Consulta Switch to sheet action alla pagina 1533.
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Close action
The Close action in the Excel basic package enables you to close an excel spreadsheet and Save changes
when closing the file.

Impostazioni

Closes the current workbook and provides an option to Save changes when closing the file.Enter the
name of the session used to open the workbook with the Open .

Nota:  This action terminates the process for the session.

Delete cells action
The Delete cells action in the Excel basic package enables you to delete the Active cell or a Specific cell
from the current worksheet.

Impostazioni

• Select the Active cell or Specific cell option to specify whether to retrieve the values from the active
cell or a specific cell.

• Select the Shift cells left or Shift cells up option to specify whether to shift the cell one position to
the left or up after the cell is deleted.

• Select the Entire row or Entire column option to specify whether to delete the entire row or column
of the cell.

• Enter the name of the session used to open the workbook with the Open .

Get multiple cells action
The Get multiple cells action in the Excel basic package enables you to retrieve the values from cells in a
Microsoft Excel spreadsheet and stores them in a table variable.

Impostazioni

This action retrieves cell values as string data types. It supports Excel cell formats, including Number,
Percentage, Currency, Scientific, and Date. For example, a value from a cell of Currency formatting retains
the currency symbol when passed to a table or record variable.

Nota:  You must convert the values to perform non-string operations.

• Select any of the following options from the Loop through field:

Opzione Azione

All rows: Enables you to retrieve the values from all the
rows.

Specific row: Enables you to retrieve the values from the
row you have specified in the From row and
to row fields.
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Opzione Azione

Cell range: Enables you to retrieve the values from the
range of cells you have specified in the From
cell and to cell field.

• Enter the name of the session used to open the workbook with the Open .
• In the Get value to the variable (optional) field, create or insert an existing string variable.

Get single cell action
The Get single cell action in the Excel basic package enables you to retrieve the values from a single cell in
a Microsoft Excel spreadsheet and stores them in a string variable .

Impostazioni

This  retrieves cell values as string data types. It supports Excel cell formats, including Number,
Percentage, Currency, Scientific, and Date. For example, a value from a cell of Currency formatting retains
the currency symbol when passed to a table or record variable.

Nota:  You must convert the values to perform non-string operations.

• Select the Active cell or Specific cell option to specify whether to retrieve the values from the active
cell or a specific cell.

• Enter the name of the session used to open the workbook with the Open .
• In the Store cell contents to field, create or insert an existing string variable.

You can use the output value to
Example of using a conditional statement alla pagina 2058
.

Get cell address action
The Get cell address action in the Excel basic package enables you to retrieve the location of the active cell
and stores it to a string variable.

Impostazioni

• Enter the name of the session used to open the workbook with the Open .
• In the Save the active cell address in local variable field, create or insert an existing string

variable.

Get column name action
The Get column name action in the Excel basic package enables you to retrieve the letter value of the
column of the active or specific cell and store it to a string variable.

Impostazioni

• Select the Active cell or Specific cell option to specify whether to retrieve the column name from the
active cell or a specific cell.
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• Enter the name of the session used to open the workbook with the Open .
• In the Save the column name into local variable field, create or insert an existing string variable.

Get row number action
The Get row number action in the Excel basic package enables you to retrieve the row number of the
active or specific cell and stores it to a string variable.

Impostazioni

• Select the Active cell or Specific cell option to specify whether to retrieve the row number from the
active cell or a specific cell.

• Enter the name of the session used to open the workbook with the Open .
• In the Save the row number into local variable field, create or insert an existing string variable.

Go to cell action
The Go to cell action in the Excel basic package enables you to select a specific cell in a Microsoft Excel
spreadsheet.

Impostazioni

• Select the Active cell or Specific cell option to specify which cell to select.
• Enter the name of the session used to open the workbook with the Open .

Using the Open action for Excel basic
Use the Open action to open a Microsoft Excel spreadsheet with .xlsx extension. This action enables you
to specify whether to open the spreadsheet in read-only mode or read-write mode, a password to open the
spreadsheet, and so on.
To open a Microsoft Excel spreadsheet, do the following:
1. Double-click or drag the Open action from the Excel basic package in the Actions palette.
2. Select from where you want to open the Microsoft Excel spreadsheet:

Nota:  The Excel basic package supports files that are a maximum size of 30 MB.

• File Control Room: Enables you to open a file from the Control Room.
• File desktop: Enables you to open a file from the device. This field also accepts the file path input

as a string variable or global value.
• Variabile: Enables you to open a file by specifying a file variable.

3. Seleziona la casella di controllo Il foglio contiene un'intestazione se il foglio di calcolo Microsoft
Excel contiene una riga di intestazione.

4. Seleziona l'opzione Nome foglio specifico e specifica il nome del foglio da attivare quando il foglio di
calcolo Microsoft Excel viene aperto.

5. Select Read-only mode or Read-write mode to open the Microsoft Excel spreadsheet in read-only
or edit mode, respectively.

6. Select the Password is required check box if a password is required to open the Microsoft Excel
spreadsheet.

7. Select any of the following tabs to create an Excel session:
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• Sessione locale: Specifica un nome sessione utilizzabile solo nel bot corrente.
• Sessione globale: Specify a session name that can be used across multiple bots, such as parent

bots, child bots, and other child bots of the parent bots.
You can also use the Global session option to loop through each row in an Excel advanced
worksheet.

Nota:  You can open an Excel worksheet by using the Global session option and use it across
multiple bots without having to share the session by using the Set session variable action.

You can also close the session from the child bot when you are using the Global session option
and sharing the session across child bots.

Importante:  If you close the session from the child bot and run the parent bot, then in the
parent bot, the actions that come after the child bot are not run, and the bot fails with an error
because the session has already been closed from the child bot.

• Variabile: Specifica una variabile di sessione utilizzabile per condividere quella sessione con altri
bots figlio.

Nota:  Quando utilizzi più fogli di calcolo per automatizzare un'operazione, ti occorre utilizzare nomi
di sessione diversi per ciascun foglio di calcolo. Se desideri utilizzare lo stesso nome di sessione per
automatizzare tutti i fogli di calcolo, devi chiudere la sessione di un foglio di calcolo prima di utilizzare
lo stesso nome di sessione per un altro foglio di calcolo.

8. Enter the name of the session in the Session name field.
9. Fai clic su Salva.

Save workbook action
The Save workbook action in the Excel basic package enables you to save a Microsoft Excel spreadsheet to
a specified location.

Impostazioni

Enter the name of the session used to open the workbook with the Open .

Nota:  When you open an excel file from the Control Room and make changes in the file, the updated file
does not save in the Control Room This action is supported only for Excel files opened from the desktop.

Set cell action
The Set cell action in the Excel basic package enables you to set the value you have specified in a cell in a
Microsoft Excel spreadsheet.

Impostazioni

• Select the Active cell or Specific cell option to specify whether to set the value in the active cell or a
specific cell.

• Enter the cell value to set in the Value to set field.
• Enter the name of the session or variable used to open the workbook with the Openaction.
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Switch to sheet action
The Switch to sheet action in the Excel basic package enables you to activate a specific worksheet.

Impostazioni

• Select to activate the worksheet by the Index value or worksheet Name.
The index is the numeric value assigned to the worksheet.

• Enter the name of the session used to open the workbook with the Open .

Excel advanced package
Il package Excel advanced contiene actions che consentono di automatizzare molte delle attività ripetitive
quando si lavora con i fogli di calcolo di Microsoft Excel.
Puoi automatizzare le attività relative alle cartelle di lavoro, ai fogli di calcolo, alle righe, alle colonne e alle
operazioni sulle celle. You can use these actions when Microsoft Excel is installed on the device that you
want to use to automate the Microsoft Excel-related tasks.

Nota:
• Il file Excel utilizzato dalla Control Room è applicabile solo per la sessione bot corrente. If you modify

the file during bot execution, the updated file cannot be uploaded back to the Control Room
• If your current office installation is any of the following:

• Microsoft 365 Apps for Enterprise
• Office 2016, 2019, or 2021 (Consumer Version 2009 or later)

Then you do not need to install the Microsoft Access Database Engine as an additional component in
your system.
However, if you have both Microsoft 365 Apps and the Microsoft Access Database Engine are installed
on your system, then you can uninstall the Microsoft Access Database Engine and repair Microsoft 365
Apps.
Microsoft recommends that you do not install the Microsoft Access Database Engine driver separately
because both the Microsoft Access Database Engine 2016 and Microsoft 365 Apps use the same major
version identifier (16.0). To learn more about the Microsoft Access Database Engine driver installation
requirement, see Unable to use the Access ODBC or OLEDB provider

Importante:  When you use Microsoft Excel Version 2208 and a bot tries to open an unprotected macro,
a security warning is displayed indicating that the macros are blocked as they are not from a trusted
source.
Per maggiori dettagli, consulta Macros from the internet will be blocked by default in Office.

Important:  If you use different versions of the Excel advanced package in a parent bot and a child bot,
the capability to share a session across bots is currently not supported. To share a session across parent
and child bots, ensure that you use the same version of the package in both the parent and child bots.

Le Actions nel package Excel advanced supportano da Microsoft Office 2016 a Microsoft Office 2019,
Microsoft Office 365 e i seguenti formati di file:
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• .xls
• .xlsx
• .xlsb
• .xml
• .xlsm
• .txt
• .ods
• .htm
• .html
• .mht
• .mhtml
• .slk
• .pdf

Importante:
• For files with .ods extension, unless you specify the sheet name in the Specify sheet name field of

the Open action, the action always opens the .ods file with the first sheet as active, by default. If the
sheet name contains a space character, after you save and close the Excel sheet, the space character is
displayed as underscore.

• Files with the .htm, .html, .mht, and .mhtml extensions cannot be converted into PDF.
• Files with the .slk and .pdf extensions contain only a single sheet. The sheet cannot be renamed. If

you rename the sheet and save the Excel sheet, the sheet does not retain the new name.
• Files with .htm, .html, .mht, .mhtml, .slk, and .pdf extensions cannot retain passwords.
• You cannot run a macro in files with the .pdf extension.
• Nota: Macro-enabled Excel applications with VBA using 32-bit and 64-bit code are not

supported. If you encounter a Compile error in hidden module error message when
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running a macro, then see the following image to add the VBA code manually in the Excel file

You can also use some of the actions with the .csv format. Consulta CSV operations in Excel advanced alla
pagina 1561.
Consulta Esempio di migrazione dei dati da Excel a un database alla pagina 1464.

Choosing the Excel package in Automation 360

Automation 360 includes packages to support three types of Microsoft Excel usage. For optimal results, use
the package that corresponds to the type of Excel that is available on the device you are running bots on.
• Nessun Excel installato: If you do not have Microsoft Excel installed on the device on which you are

running bots to automate Excel-related processes, use the Excel basic package.
• Installata la versione desktop di Excel: If you have a desktop version of Microsoft Excel installed

on your computer, use the Excel advanced package in your bots.
• Solo Office 365 Excel online: If you are using Microsoft Excel 365 on a web browser, use the Office

365 Excel package for automating tasks related to Excel.
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Prima di iniziare

Esegui le seguenti actions contenute nel package Excel advanced come parte integrante dell'utilizzo del set
di actions disponibili:
1. Open the Microsoft Excel spreadsheet that you want to use to automate the Microsoft Excel-related

tasks. Utilizza l'action Apri per aprire il foglio di calcolo. Consulta Using the Open action for Excel
advanced alla pagina 1539.

Nota:  For files containing large data sets, use actions from the Database package to automate
create, read, and update operations. Consulta Utilizzo dell'action Connetti per il database alla pagina
1451.

2. Use the different actions available in the Excel advanced package to automate the Microsoft Excel-
related tasks.

3. Dopo aver automatizzato tutte le attività correlate a Microsoft Excel, chiudi il foglio di calcolo
utilizzando l'action Chiudi.

Actions nel package Excel advanced

The actions in the Excel advanced package enable you to perform the following operations:

Action Descrizione

Cell operations Perform operations such as extracting data from cells, deleting values from
a cell, moving a cursor to a specific cell, and finding and replacing content.
Consulta Cell operations in Excel advanced alla pagina 1551.

Row and column
operations

Perform operations such as inserting new rows and columns, and hiding
and unhiding rows and columns. Consulta Row and column operations in
Excel advanced alla pagina 1548.

Table operations Perform operations such as sorting and filtering data in a table, inserting
and deleting columns, and getting the table range. Consulta Table
operations in Excel advanced alla pagina 1559.

Workbook operations Perform operations such as opening a workbook, appending data,
protecting and unprotecting a workbook, and converting a Microsoft Excel
workbook to a PDF file. Consulta Workbook operations in Excel advanced alla
pagina 1537.

Operazioni sui fogli di
lavoro

Perform operations such as creating and deleting a worksheet, appending
data, and hiding and unhiding a worksheet. Consulta Worksheet operations
in Excel advanced alla pagina 1542.

Example tasks:
• Example of transferring data from CSV file to Excel worksheet alla pagina 2063
• Example of using a conditional statement alla pagina 2058
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More resources

• Free Automation 360 bot examples for Excel from Bot Store:
• Merge Excel Sheets Example
• Convert XML to Excel
• Convert multiple Excel files to CSV files

• Tutorial sull'utilizzo dei pacchetti Excel: Work with large Excel datasets in a bot
• Corso di formazione Automazione delle cartelle di lavoro di Excel - Automation Anywhere University: RPA

Training and Certification (A-People login required)

Attività correlate
Using Find action in Excel alla pagina 1553
Use the Find action to find a particular string in a Microsoft Excel spreadsheet or a CSV file.

Workbook operations in Excel advanced
A workbook is a file that contains one or more worksheets. The Excel advanced package contains various
actions that you can use to automate workbook-related tasks.

Workbook actions in the Excel advanced package

Il pacchetto Excel avanzato comprende le seguenti azioni:

Azione Descrizione

Aggiungi cartella di
lavoro

Vedi Append workbook action alla pagina 1537

Chiudi Vedi Close action alla pagina 1538

Converti Excel in PDF Vedi Convert excel to PDF action alla pagina 1538

Crea cartella di lavoro Vedi Create workbook action alla pagina 1538

Apri Consulta Using the Open action for Excel advanced alla pagina 1539.

Proteggi cartella di
lavoro

Vedi Protect workbook action alla pagina 1541

Salva cartella di lavoro Vedi Save workbook action alla pagina 1541

Rimuovi protezione
cartella di lavoro

Vedi Unprotect workbook action alla pagina 1541

Append workbook action
The Append workbook action in the Excel advanced package enables you to add all the worksheets from
the specified workbook to the end of the currently open workbook.

Impostazioni

• Enter the name of the session used to open the workbook with the Open .
• Specify the workbook from which you want to append the worksheets in the Append from workbook

field.
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• If the workbook is protected, select the Password is required check box and enter the password in
the To open field.

• In the To open field, provide your password with one of the following options:
• Credenziale: Select a credential from the . Credentials and credential variables in the Bot editor alla

pagina 2039
• Variabile: Select a variable holding a credential data type value. Le tue variabili (definite dall'utente)

alla pagina 2026
• Insecure string: Enter a value or select a variable.

Importante:  Values entered using this option are not encrypted.

Close action
The Close action in the Excel advanced package enables you to close the current workbook and provide an
option to save changes when closing the file.

Impostazioni

Enter the name of the session used to open the workbook with the Open .
Convert excel to PDF action
The Convert excel to PDF action of the Excel advanced package enables you to convert the entire
workbook, specific worksheets in a workbook, or a CSV file to a PDF file.

Impostazioni

• Enter the name of the session used to open the workbook with the Open .
• Specify whether you want to convert the Entire excel file, Active sheet, or Specific sheet to a PDF

file.
• Enter a name for the PDF file in the Select PDF file name field.
• Specify the location where you want to save the file in the Select PDF storage location field.

Create workbook action
The Create workbook action of the Excel advanced package enables you to create a Microsoft Excel
workbook or a CSV file.

Impostazioni

• Enter the name of the session used to open the workbook with the Open .
• Specify the location where you want to save the workbook in the File path field.
• Specify the name of the worksheet in the Sheet name field.
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• Specify the passwords to open and edit the workbook in the Password to open and Password to
edit fields. Provide your password with one of the following options:
• Credenziale: Select a credential from the . Credentials and credential variables in the Bot editor alla

pagina 2039
• Variabile: Select a variable holding a credential data type value. Le tue variabili (definite dall'utente)

alla pagina 2026
• Insecure string: Enter a value or select a variable.

Importante:  Values entered using this option are not encrypted.

• Select any of the following tabs to create an Excel session:
• Sessione locale: Specifica un nome sessione utilizzabile solo nel bot corrente.
• Sessione globale: Specifica un nome sessione utilizzabile in più bots come bots padre, bots figlio e

altri bots figli dei bots padre.
You can also use the Global session option to loop through each row in an Excel advanced
worksheet.

Nota:  You can open an Excel worksheet by using the Global session option and use it across
multiple bots without having to share the session by using the Set session variable action.

You can also close the session from the child bot when you are using the Global session option
and sharing the session across child bots.

Importante:  If you close the session from the child bot and run the parent bot, then in the parent
bot, the actions that come after the child bot are not run, and the bot fails with an error because the
session has already been closed from the child bot.

• Variabile: Specifica una variabile di sessione utilizzabile per condividere quella sessione con altri
bots figlio.

Nota:  If the Microsoft sensitivity label feature is enabled for Office 365 Excel application, see
Automation Anywhere interaction with Microsoft Labels (A-people login required)

Using the Open action for Excel advanced
Use the Open action to open a Microsoft Excel spreadsheet or a CSV file. This action enables you to
specify whether to open the spreadsheet in read-only mode or read-write mode, a password to open the
spreadsheet, and so on.
When you use the Open action to open a macro-enabled Excel workbook of .xlsm format, the Auto_Open
VBA procedure does not run automatically because the VBA procedure runs only when the Excel workbook
is opened manually. This is a default behavior of Microsoft Excel. Consulta Behavior difference between
Workbook_Open and Auto_Open procedure.

Nota:  È possibile utilizzare la ricerca basata su modelli di carattere jolly per aprire un file excel esistente
corrispondente ai criteri di ricerca. Per esempio, se hai più file con nomi simili come table1.xlsx,
table2.xlsx, table3.xlsx, è possibile aprire il file specificando i caratteri jolly (*) nel percorso del file
come table*.xlsx per aprire il primo file corrispondente al modello.

1. Double-click or drag the Open action from the Excel advanced package in the Actions palette.
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2. Select from where you want to open the Microsoft Excel spreadsheet:
• File: Select one of the following options to open a Microsoft Excel spreadsheet:

• File Control Room: Enables you to open a file from the Control Room.
• File desktop: Enables you to open a file from the device. This field also accepts the file path

input as a string variable or global value.

Nota:  In the Desktop file field, if you enter a file path or browse to a particular file from
the system and if the file path is separated by the backslash (\) characters, when you save the
bot, the backslash characters are changed to slash (/) characters because the bot uses slash
characters to separate file paths. Your bots continue to run successfully even if the backslash
characters are is changed to slash characters during bot run.

• Variabile: Enables you to open a file by specifying a file variable.

• SharePoint: In the File path field, enter the exact file path of the Excel spreadsheet on
SharePoint. To copy the URL of the Excel spreadsheet from SharePoint, perform the following
steps:
• Open the Microsoft Excel spreadsheet on SharePoint.
• In the Microsoft Excel spreadsheet, navigate to File > Info.
• Click Copy path.

3. Seleziona la casella di controllo Il foglio contiene un'intestazione se il foglio di calcolo Microsoft
Excel contiene una riga di intestazione.

4. Seleziona l'opzione Nome foglio specifico e specifica il nome del foglio da attivare quando il foglio di
calcolo Microsoft Excel viene aperto.

5. Seleziona Modalità sola lettura o Modalità lettura-scrittura per aprire il foglio di calcolo
rispettivamente in modalità di sola lettura o di modifica.

6. Seleziona la casella di controllo Password obbligatoria se è necessaria una password per aprire o
modificare il foglio di calcolo Microsoft Excel.

7. Seleziona la casella di controllo Carica add-in se desideri caricare gli add-in disponibili nel foglio di
calcolo Microsoft Excel.

8. Select the Exclude hidden sheets check box if you want to ignore the excel sheets that are hidden
and do not want to perform any operation on those hidden sheets.
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9. Select any of the following tabs to create an Excel session:
• Sessione locale: Specifica un nome sessione utilizzabile solo nel bot corrente.
• Sessione globale: Specify a session name that can be used across multiple bots, such as parent

bots, child bots, and other child bots of the parent bots.
You can also use the Global session option to loop through each row in an Excel advanced
worksheet.

Nota:  You can open an Excel worksheet by using the Global session option and use it across
multiple bots without having to share the session by using the Set session variable action.

You can also close the session from the child bot when you are using the Global session option
and sharing the session across child bots.

Importante:  If you close the session from the child bot and run the parent bot, then in the
parent bot, the actions that come after the child bot are not run, and the bot fails with an error
because the session has already been closed from the child bot.

• Variabile: Specifica una variabile di sessione utilizzabile per condividere quella sessione con altri
bots figlio.

Nota:  Quando utilizzi più fogli di calcolo per automatizzare un'operazione, ti occorre utilizzare nomi
di sessione diversi per ciascun foglio di calcolo. Se desideri utilizzare lo stesso nome di sessione per
automatizzare tutti i fogli di calcolo, devi chiudere la sessione di un foglio di calcolo prima di utilizzare
lo stesso nome di sessione per un altro foglio di calcolo.

10. Fai clic su Salva.

Protect workbook action
The Protect workbook action of the Excel advanced package enables you to protect the workbook and
its structure using a password. Protecting a workbook prevents other users from opening the workbook
without the password, and protecting the structure of a workbook prevents other users from adding,
moving, deleting, hiding, and renaming worksheets within that workbook.

Impostazioni

• Enter the name of the session used to open the workbook with the Open .
• Select the Protect workbook and Protect workbook structure check boxes and provide a

password in the respective fields.

Save workbook action
The Save workbook action of the Excel advanced package enables you to save the current workbook.

Impostazioni

Enter the name of the session used to open the current workbook with the Open action.

Nota:  When you open an Excel file from the Control Room and make changes to the file, the updated file
is not saved in the Control Room. This action is supported only for Excel files opened from the desktop.

Unprotect workbook action
The Unprotect workbook action of the Excel advanced package enables you to unprotect a workbook and
its structure. Unprotecting a workbook removes the restriction applied on opening the workbook, and
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unprotecting the structure of a workbook removes the restriction applied on modifying the structure of the
workbook. Unprotecting allows other users to open the workbook, add, move, delete, hide, and rename
worksheets within the workbook.

Impostazioni

• Enter the name of the session used to open the workbook with the Open .
• Select the Unprotect workbook and Unprotect workbook structure check boxes and provide a

password to unprotect the workbook structure.

Worksheet operations in Excel advanced
Il pacchetto Excel avanzato contiene varie azioni che puoi utilizzare per automatizzare le attività correlate
ai fogli di lavoro.

Azioni sul foglio di lavoro nel pacchetto Excel avanzato

Il pacchetto Excel avanzato comprende le seguenti azioni:

Azione Descrizione

Accedi a cartella di lavoro
protetta da password

Vedi Access password protected worksheet action alla pagina 1543

Aggiungi fogli di lavoro Consulta Using Append worksheet action alla pagina 1543.

Crea foglio di lavoro Vedi Create worksheet action alla pagina 1543

Elimina foglio di lavoro Vedi Delete worksheet action alla pagina 1544

Disabilita o abilita
l'aggiornamento dello
schermo in tempo reale

Vedi Disable or enable real-time screen update action alla pagina 1544

Ottieni nome foglio di
lavoro corrente

Vedi Get current worksheet name action alla pagina 1544

Ottieni foglio di lavoro
come tabella dati

Vedi Get worksheet as data table action alla pagina 1545

Ottieni nome fogli di lavoro Vedi Get worksheet names action alla pagina 1545

Nascondi foglio di lavoro Vedi Hide worksheet action alla pagina 1545

Proteggi foglio di lavoro
con password

Vedi Password protect worksheet action alla pagina 1545

Rinomina foglio di lavoro Vedi Rename worksheet action alla pagina 1546

Recupera il conto dei fogli Vedi Retrieve sheets count action alla pagina 1546

Esegui macro See Run macro action alla pagina 1546

Passa al foglio Vedi Switch to sheet action alla pagina 1547

Scopri tutti i fogli di lavoro Vedi Unhide all worksheets action alla pagina 1547

Scopri fogli di lavoro Vedi Unhide worksheet action alla pagina 1547

Scrivi da tabella dati Vedi Write from data table action alla pagina 1547
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Access password protected worksheet action
The Access password protected worksheet action of the Excel advanced package enables you to access a
password-protected worksheet in the current workbook.

Impostazioni

• Enter the name of the session used to open the workbook with the Open .
• Inserisci la password per accedere al foglio di lavoro.

Using Append worksheet action
Use the Append worksheet action to append a worksheet from another workbook to the current
workbook.

Nota:  If the current workbook already has a worksheet with the same name, you must rename the
worksheet being appended.

To append a worksheet, do the following:
1. Double-click or drag the Append worksheet action from the Excel node in the Actions palette.
2. Select an option to specify the location of the spreadsheet from which you want to append the

worksheet:
• From 'My bots': Enables you to open a Microsoft Excel spreadsheet from an existing bot.
• From local device: Enables you to open a Microsoft Excel spreadsheet from a local device.
• Select an existing file variable: Enables you to open a Microsoft Excel spreadsheet using a file

variable.

3. Select the Password is required option if the Microsoft Excel spreadsheet requires a password to
open it.

4. Opzionale: In the User password or Owner password field, enter a password to restrict access to
the encrypted PDF file.
• User password: Allow users to perform specific operations on the encrypted PDF file.
• Owner password: Allow users to use a password to open the file.

5. Select the Enter worksheet name or Enter worksheet index option to specify the name or
number of the worksheet that you want to append.

6. Enter the name of the session used to open the workbook with the Open .
7. Fai clic su Salva.

Create worksheet action
The Create worksheet action of the Excel advanced package enables you to create a worksheet in the
current workbook.

Impostazioni

• Enter the name of the session used to open the workbook with the Open .
• Specifica un numero indice nel campo Foglio per indice o un nome per il foglio di lavoro nel campo

Foglio per nome. The index number is the number assigned to a worksheet. For example, if you want
to perform an operation on the worksheet at the third position in the workbook, enter 3 in the field.
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Delete worksheet action
The Delete worksheet action of the Excel advanced package enables you to delete a spreadsheet from the
current workbook.

Impostazioni

• Enter the name of the session used to open the workbook with the Open .
• Specifica un numero indice nel campo Foglio per indice o un nome per il foglio di lavoro nel campo

Foglio per nome. The index number is the number assigned to a worksheet. For example, if you want
to perform an operation on the worksheet at the third position in the workbook, enter 3 in the field.

Nota:  Puoi eliminare un foglio di lavoro solo se la cartella di lavoro ne contiene più di uno.

Disable or enable real-time screen update action
The Disable or enable real-time screen update action of the Excel advanced package enables you to
disable the real-time screen update.

Impostazioni

• Seleziona il tasto Disabilita per disabilitare l'aggiornamento dello schermo in tempo reale quando si
eseguono actions in un foglio di lavoro di Microsoft Excel con grandi set di dati.

• Seleziona l'opzione Abilita per riabilitare l'aggiornamento dello schermo in tempo reale per altre actions
successive.

• Inserisci l'action che ha problemi di prestazioni all'interno dell'action Disabilita o abilita
l'aggiornamento dello schermo in tempo reale.
Ad esempio, se stai usando l'action Esegui macro per eseguire una macro su un foglio di lavoro
contenente grandi set di dati e riscontri problemi di prestazioni, utilizza l'opzione Disabilita o abilita
l'aggiornamento dello schermo in tempo realeaction prima dell'action Esegui macro e seleziona
il tasto Disabilita per disabilitare l'aggiornamento dello schermo in tempo reale e migliorare così le
prestazioni. Usa l'action Disabilita o abilita l'aggiornamento dello schermo in tempo reale di
nuovo dopo l'action Esegui macro e seleziona l'opzione Abilita per riabilitare l'aggiornamento dello
schermo in tempo reale per altre azioni actions successive.

Importante:  Consigliamo di usare questa action solo se si riscontrano problemi di prestazioni quando si
esegue l'actions con grandi set di dati.

Get current worksheet name action
The Get current worksheet name action of the Excel advanced package enables you to get the name of the
current worksheet and assign it to a string variable.

Impostazioni

• Enter the name of the session used to open the workbook with the Open .
• Select a string variable that you want to use to store the name of the worksheet from the Assign the

output to variable list. La  mostra un nome descrittivo predefinito della variabile. If you create several
output variables, subsequent variable names are appended with a -1, -2, -3, and so on to avoid
duplication.
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Get worksheet as data table action
Thet Get worksheet as data table action of the Excel advanced package enables you to get data from a
worksheet and save it to a table variable.

Impostazioni

• Specifica un numero indice nel campo Foglio per indice o un nome per il foglio di lavoro nel campo
Foglio per nome. The index number is the number assigned to a worksheet. For example, if you want
to perform an operation on the worksheet at the third position in the workbook, enter 3 in the field.

• Scegli dall'opzione Leggi per leggere il testo visibile o il valore della cella.
Ad esempio, se la cella ha il 70% come contenuto di cella, l'opzione Leggi valore cella leggerà il
valore come 70 ignorando il formato %, mentre l'opzione Leggi testo visibile leggerà il contenuto
come 70%.

Recommendation:  Utilizza l'opzione Leggi valore cella poiché la lettura di un valore da una cella
offre prestazioni migliori rispetto alla lettura del testo visibile.

• Enter the name of the session used to open the workbook with the Open .
• Select a table variable that you want to use to store the data from the worksheet from the Assign

value to the variable list. La  mostra un nome descrittivo predefinito della variabile. If you create
several output variables, subsequent variable names are appended with a -1, -2, -3, and so on to
avoid duplication.

Get worksheet names action
The Get worksheet names action of the Excel advanced package enables you to get the names of all the
worksheets and assign them to a list variable of string data type.

Impostazioni

• Enter the name of the session used to open the workbook with the Open .
• Select a string variable that you want to use to store the name of the worksheet from the Assign the

output to variable list. La  mostra un nome descrittivo predefinito della variabile. If you create several
output variables, subsequent variable names are appended with a -1, -2, -3, and so on to avoid
duplication.

Hide worksheet action
The Hide worksheet action of the Excel advanced package enables you to hide a worksheet from the
current workbook.

Impostazioni

• Specifica il nome del foglio di lavoro da nascondere nel campo Inserisci il nome del foglio di lavoro
da nascondere.

Nota:  Puoi nascondere un foglio di lavoro solo se la cartella di lavoro ne contiene più di uno.

• Enter the name of the session used to open the workbook with the Open .

Password protect worksheet action
The Password protect worksheet action of the Excel advanced package enables you to protect a worksheet
with a password. Puoi anche specificare le operazioni da limitare sul foglio di lavoro.
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Impostazioni

• Specifica la password che desideri utilizzare per proteggere il foglio di lavoro e seleziona le caselle
di controllo per l'operazione che desideri limitare sul foglio di lavoro. Ad esempio, puoi selezionare le
caselle di controllo Elimina riga ed Elimina colonna per impedire a un utente di eliminare una riga o
una colonna dal foglio di lavoro.

• Enter the name of the session used to open the workbook with the Open .

Rename worksheet action
The Rename worksheet action of the Excel advanced package enables you to rename a worksheet in the
current workbook.

Impostazioni

• Specifica il numero indice o il nome del foglio di lavoro da eliminare nel campo Foglio per indice o
Foglio per nome.
Il numero indice è il numero assegnato a un foglio di lavoro. Ad esempio, se desideri eseguire
un'operazione sul foglio di lavoro nella terza posizione della cartella di lavoro, inserisci 3 nel campo.

Nota:  Non puoi rinominare il foglio di lavoro se esiste già un foglio di lavoro con lo stesso nome nella
cartella di lavoro.

• Inserisci un nuovo nome del foglio di lavoro che sia inferiore a 31 caratteri.
• Enter the name of the session used to open the workbook with the Open .

Retrieve sheets count action
The Retrieve sheets count action of the Excel advanced package enables you to get the number of sheets
available in the current workbook and store it in a number variable.

Impostazioni

• Seleziona l'opzione appropriata per specificare se includere o meno il foglio di lavoro nascosto e
assegna il conteggio a una variabile.

• Enter the name of the session used to open the workbook with the Open .
• Select a number variable that you want to use to store the name of the worksheet from the Select

the variable to assign to list. La  mostra un nome descrittivo predefinito della variabile. If you create
several output variables, subsequent variable names are appended with a -1, -2, -3, and so on to
avoid duplication.

Run macro action
The Run macro action in the Excel advanced package enables you to run macros in a worksheet.

Impostazioni

• Specifica il nome della macro che desideri eseguire e i relativi argomenti.
• Enter the name of the session used to open the workbook with the Open .

Nota:
• When you write a macro code, always end the code by adding Exit Sub.
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• If you add End to terminate the macro, then on execution, the bot can fail with an error.
• Ensure that a macro code contains only one instance of the End or End Sub statement in the macro

code to terminate the macro. If there is more than one instance of the statement, then on execution,
the bot might fail with an error.

Esempio:

Public Sub main()
MsgBox "Hello”
MsgBox “Hello2”
End Sub

Switch to sheet action
The Switch to sheet action in the Excel advanced package activates a particular sheet in a Microsoft Excel
file.

Impostazioni

• Specifica se attivare Foglio per indice (valore numerico) o Foglio per nome.
• Enter the name of the session used to open the workbook with the Open .

Nota:  Il bot che contiene l'azione Passa al foglio passa al foglio di lavoro nascosto ed esegue operazioni
su di esso. Al termine delle operazioni, il foglio di lavoro rimane nascosto e non viene attivato.

Unhide all worksheets action
The Unhides all worksheets action in the Excel advanced package unhides all the worksheets in the current
workbook.

Impostazioni

Scopre tutti i fogli di lavoro nella cartella di lavoro corrente. Immetti il nome della sessione utilizzata per
aprire la cartella di lavoro corrente utilizzando l'azione Apri.
Unhide worksheet action
The Unhide worksheet action in the Excel advanced package unhides a specific worksheet in the current
workbook.

Impostazioni

• Inserisci il nome del foglio di lavoro che desideri scoprire.
• Enter the name of the session used to open the workbook with the Open .

Write from data table action
The Write from data table action in the Excel advanced package enables you to write values from a data
table into a worksheet.

Impostazioni

• Specifica la variabile tabella dati che contiene i dati che desideri scrivere in un foglio di lavoro.
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• Specifica se desideri scrivere i dati nel Foglio di lavoro attivo corrente o nel Foglio di lavoro
specifico.

• Specifica l'indirizzo della cella che desideri utilizzare come punto iniziale dei dati nel campo Specifica la
prima cella.

• Enter the name of the session used to open the workbook with the Open .

Row and column operations in Excel advanced
Il pacchetto Excel avanzato contiene varie azioni che puoi utilizzare per automatizzare le attività correlate
alle operazioni righe e colonne in un foglio di calcolo di Microsoft Excel.

Row and column actions in the Excel advanced package

Il pacchetto Excel avanzato comprende le seguenti azioni:

Azione Descrizione

Ottieni nome colonna Vedi Get column name action alla pagina 1548

Ottieni numero di riga Vedi Get row number action alla pagina 1548

Nascondi righe/colonne
nella selezione

Vedi Hide rows/columns in selection action alla pagina 1549

Insert/Delete Rows/
Columns

Consulta Using Insert or Delete actions for rows and columns alla pagina
1549.

Leggi colonna Vedi Read column action alla pagina 1549

Leggi riga Vedi Read row action alla pagina 1550

Rimuovi righe vuote Vedi Remove blank rows action alla pagina 1550

Select cell(s)/row(s)/
column(s)

Consulta Using Select action for cells, rows, and columns alla pagina 1550.

Unhides rows/columns
in selection

Vedi Unhides rows/columns in selection action alla pagina 1551

Get column name action
The Get column name in the Excel advanced package enables you to retrieve the column name that
contains the specific cell and stores it to a string variable. This action supports .xlsx and .xlxm files.

Impostazioni

• Seleziona l'opzione Cella attiva o Cella specifica per specificare la posizione della cella.
• Enter the name of the session used to open the workbook with the Open .
• Select a string variable from the Save the column name to variable list. La  mostra un nome

descrittivo predefinito della variabile. If you create several output variables, subsequent variable names
are appended with a -1, -2, -3, and so on to avoid duplication.

Get row number action
The Get row number action in the Excel advanced package enables you to retrieve the row number that
contains the specific cell and stores it to a string variable. This action supports .xlsx and .xlxm files.
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Impostazioni

This action supports .xlsx and .xlxm files.
• Seleziona l'opzione Cella attiva o Cella specifica per specificare la posizione della cella.
• Enter the name of the session used to open the workbook with the Open .
• Select a string variable from the Save the row number to variable list. La  mostra un nome

descrittivo predefinito della variabile. If you create several output variables, subsequent variable names
are appended with a -1, -2, -3, and so on to avoid duplication.

Hide rows/columns in selection action
The Hide row/columns in selection action in the Excel advanced package enables you to hide rows or
columns in the current worksheet.

Impostazioni

• Select the appropriate option to specify whether to hide one or more rows and columns.
• Enter the name of the session used to open the workbook with the Open .

Using Insert or Delete actions for rows and columns
Use the Insert or Delete actions to create or remove rows or columns from the current worksheet or CSV
file.
To change the name or value of an Active cell or a Specified cell in a Microsoft Excel spreadsheet or a
CSV file in a row or a column, see Set cell.
To insert or delete rows or columns in a worksheet, do the following:
1. Double-click or drag the Insert or Delete action from the Excel node in the Actions palette.
2. Select the Row operations if you want to insert or delete rows from the spreadsheet.

a) Select the Insert Row at option to insert a row and specify the location where you want to
insert the row in the field.

b) Select the Delete Row(s) at option to delete rows. You must specify the row number you want
to delete in the field. For example, if you want to delete the tenth row in the worksheet, you must
enter 10 in the field. If you want to delete the first five rows, you must enter 1:5 in the field.

3. Select the Column operations if you want to insert or delete columns from the spreadsheet.
a) Select the Insert Column at option to insert a column and specify the location where you want

to insert the column in the field.
b) Select the Delete Column(s) at option to delete columns. You must specify the address of

the column you want to delete in the field. For example, if you want to delete column 'D' in the
worksheet, you must enter D in the field. If you want to delete the first five columns, you must
enter A:E in the field.

4. Enter the name of the session used to open the workbook with the Open .
5. Fai clic su Salva.

Read column action
The Read column action in the Excel advanced package enables you to extract data from a column and
stores it in a list variable of string data type.
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Impostazioni

• Seleziona l'opzione Da cella attiva o Da cella specifica per specificare il punto iniziale. Puoi anche
selezionare l'opzione Leggi colonna intera per estrarre i dati per l'intera colonna.

• Scegli dall'opzione Leggi per leggere il testo visibile o il valore della cella.
Ad esempio, se la cella ha il 70% come contenuto di cella, l'opzione Leggi valore cella leggerà il
valore come 70 ignorando il formato %, mentre l'opzione Leggi testo visibile leggerà il contenuto
come 70%.

Recommendation:  Utilizza l'opzione Leggi valore cella poiché la lettura di un valore da una cella
offre prestazioni migliori rispetto alla lettura del testo visibile.

• Enter the name of the session used to open the workbook with the Open .
• Select a table variable to store the extracted values.

Nota:  This action overwrites any existing values in the selected table.

La  mostra un nome descrittivo predefinito della variabile. If you create several output variables,
subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.

Read row action
The Read row action in the Excel advanced package enables you to extract data from a row and stores it in
a list variable of string data type.

Impostazioni

Extracts data from a row and stores it in a list variable of string data type.
• Seleziona l'opzione Da cella attiva o Da cella specifica per specificare il punto iniziale. Puoi anche

selezionare l'opzione Leggi riga intera per estrarre i dati per l'intera riga.
• Scegli dall'opzione Leggi per leggere il testo visibile o il valore della cella.

Ad esempio, se la cella ha il 70% come contenuto di cella, l'opzione Leggi valore cella leggerà il
valore come 70 ignorando il formato %, mentre l'opzione Leggi testo visibile leggerà il contenuto
come 70%.

Recommendation:  Utilizza l'opzione Leggi valore cella poiché la lettura di un valore da una cella
offre prestazioni migliori rispetto alla lettura del testo visibile.

• Enter the name of the session used to open the workbook with the Open .
• Select a list variable of string data type that you want to use to store the extracted values. La  mostra

un nome descrittivo predefinito della variabile. If you create several output variables, subsequent
variable names are appended with a -1, -2, -3, and so on to avoid duplication.

Remove blank rows action
The Remove blank rows action in the Excel advanced package enables you to remove blank rows from the
current worksheet.

Impostazioni

You can specify the range from which you want to delete the blank rows.
Using Select action for cells, rows, and columns
Use the Select action to select cells, rows, or columns.
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To select cells, rows, or columns do the following:
1. Double-click or drag the Select cell, row, or column action from the Excel node in the Actions

palette.
2. Select an option from the Select list to specify whether you want to select a cell, row, or column.

a) If you have selected the Cell option, select any of the following options:
• Active cell: Enables you to select the active cell from the worksheet.
• Specific cell: Enables you to select the cell you have specified in the field.
• Cell range: Enables you to select all the cells in the range you have specified in the field.
• All cells in the sheet: Enables you to select all the cells in the worksheet.

b) If you have selected the Column option, select any of the following options:
• Column of active cell: Selects the column of the current active cell in the worksheet.
• Specific column: Enables you to select the column you have specified in the field.
• Column range: Enables you to select all the columns in the range you have specified in the

field.

c) If you have selected the Row option, select any of the following options:
• Row of active cell: Selects the row of the current active cell in the worksheet.
• Specific row: Enables you to select the row you have specified in the field.
• Row range: Enables you to select all the rows in the range you have specified in the field.

3. Enter the name of the session used to open the workbook with the Open .
4. Fai clic su Salva.

Unhides rows/columns in selection action
The Unhide rows/columns in selection action in Excel advanced package enables you to unhide the hidden
rows or columns in the current worksheet.

Impostazioni

• Select the appropriate option to specify whether you want to unhide a row or column and which row or
column to unhide.

• Enter the name of the session used to open the workbook with the Open .

Cell operations in Excel advanced
Il pacchetto Excel avanzato contiene varie azioni che puoi utilizzare per automatizzare le attività correlate
alle operazioni sulle celle.

Cell actions in the Excel advanced package

Il pacchetto Excel avanzato comprende le seguenti azioni:

Azione Descrizione

Elimina celle Vedi Delete cells action alla pagina 1552

Trova cella vuota
successiva

Consulta Using Find next empty cell action alla pagina 1552.

© 2023 Automation Anywhere. All rights reserved.     1551



    Automation Anywhere - Crea

Azione Descrizione

Trova Consulta Using Find action in Excel alla pagina 1553.

Ottieni indirizzo di cella Vedi Using the Get cell address action alla pagina 1553

Ottieni colore cella Consulta Using Get cell color action alla pagina 1554.

Ottieni più celle Vedi Get multiple cells action alla pagina 1555

Ottieni numero di righe Consulta Using Get number of rows action alla pagina 1556.

Ottieni cella singola Vedi Get single cell action alla pagina 1556

Vai alla cella Vedi Go to cell action alla pagina 1557

Go to next empty cell Vedi Go to next empty cell action alla pagina 1557

Leggi formula della cella Vedi Read cell formula action alla pagina 1557

Replace Consulta Using the Replace action alla pagina 1557.

Imposta cella Vedi Set cell action alla pagina 1558

Imposta formula cella Vedi Set cell formula action alla pagina 1558

Delete cells action
The Delete cell action in the Excel advanced package enables you to delete the Active cell or a Specific cell
from the current worksheet or a CSV file.

Impostazioni

Nota:  You can enter a cell range in the Specific - cell field using the starting - cell:ending
 cell format. Ad esempio, per eseguire questa operazione su tutte le celle nella seconda riga e dalla
prima alla terza colonna, immetti A2:C2.

After deleting the cell, you can:
• Sposta celle a sinistra: Deletes the specified cell and shifts the cell one position to the left.
• Sposta celle verso l'alto: Deletes the specified cell and shifts the cell one position up.
• Intera riga: Deletes the entire row that contains the cell you have specified to delete.
• Intera colonna: Deletes the entire column that contains the cell you have specified to delete.

Using Find next empty cell action
Use the Find next empty cell action to find the next empty cell in the current worksheet.
To find the next empty cell, do the following:
1. Double-click or drag the Find next empty cell action from the Excel node in the Actions palette.
2. Select the row or column option from the Traverse by section to specify whether you want to find

the empty cell in a row or column.
3. Select the active cell or specific cell option from the Start from section to specify the point from

where you want to start the search.
4. Select the string variable you want to use to store the address of the empty cell from the Assign the

output to variable list.
La  mostra un nome descrittivo predefinito della variabile. If you create several output variables,
subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.

5. Enter the name of the session used to open the workbook with the Open .
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6. Fai clic su Salva.

Using Find action in Excel
Use the Find action to find a particular string in a Microsoft Excel spreadsheet or a CSV file.
To find a value in a Microsoft Excel spreadsheet, do the following:
1. Double-click or drag the Find action from the Excel node in the Actions palette.
2. Select an option from the From list to specify a starting point of the cell range for search:

• Beginning: Starts the search from the beginning of the spreadsheet.
• End: Starts the search from the end of the spreadsheet.
• Active cell: Starts the search from the active cell in the spreadsheet.
• Specific cell: Enables you to specify the address of the cell from where you want to start the

search.

3. Select an option from the Till list to specify an end point of the cell range for search:
• Beginning: Ends the search at the beginning of the spreadsheet.
• End: Ends the search at the end of the spreadsheet.
• Active cell: Ends the search at the active cell in the spreadsheet.
• Specific cell: Enables you to specify the address of the cell where you want to end the search.

4. Specify the string you want to search for in the Find field.
5. Select from the following search options:

• By rows: Enables you to search by rows.
• By columns: Enables you to search by columns.
• Caso di corrispondenza: Only performs this action on cells that contain a string that matches the

uppercase and lowercase characters of the string you specified in the Find field.
• Match entire cell contents: Enables you to find only those cells that contain the entire string

you have specified in the Find field.

6. Enter the name of the session used to open the workbook with the Open .
7. Select the list variable of string data type that you want to use to store the output from the Assign

cell addresses to variable list.
8. Fai clic su Salva.

When you search for a value using the Find action, it will either return a list of cell addresses that contain
the value or will return an empty list if the value is not found.
Using the Get cell address action
Use the Get cell address action to retrieve the location of the active cell and store it to a string variable.
This action supports .xlsx and .xlxm files.
Open a worksheet using the Open action. You must select the Contains header option when configuring
the Open action in order to use this action to retrieve the cell address based on the column title name.
1. Double-click or drag the Get cell address action from the Excel advanced node in the Actions

palette.
2. Select whether to retrieve the cell address from the Active cell or Based on header:

Opzione Fasi

Cella attiva If you select this option, the bot will retrieve the
cell address of the currently active cell. Skip to
Step 5.
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Opzione Fasi

Based on header If you select this option, the bot will retrieve
the cell address of the cell specified by the
column title name and cell position. Complete the
following fields:
a. Enter the column title: If you selected the

Sheet contains header option when you
opened this sheet using the Open action,
enter the column name. For example, First
 Name.
If you did not select that option, enter the
default column name. For example, A.

Nota:  Questo campo non è sensibile alla
distinzione tra maiuscole/minuscole.

b. Enter cell position from column title:
Enter the number of cells between the
header cell and the cell from which you want
to retrieve the address. Enter up to three
digits.
For example, if the header cell is located at
B1 and you specify 2 as the cell position, the
action will return B3.

3. Select whether to retrieve the cell address from the Active cell or a Specific cell.
• If you have selected the Active cell option, the bot will retrieve the cell address of the currently

active cell. Skip to Step 5.
• If you have selected the Specific cell option, the bot will retrieve the cell address of the cell

specified by the column title name and cell position. Complete the following fields:
• Enter the column title: Enter the column name. For example, Name.

Nota:  Questo campo non è sensibile alla distinzione tra maiuscole/minuscole.

• Enter cell position from column title: Enter the number of cells between the header cell
and the cell from which you want to retrieve the address. Enter up to three digits.
For example, if the header cell is located at B1 and you specify 2 as the cell position, the action
will return B3.

4. In the Save active or user specified cell address in local variable field, create or insert an
existing string variable.
La  mostra un nome descrittivo predefinito della variabile. If you create several output variables,
subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.

5. Enter the name of the session used to open the workbook with the Open .
6. Fai clic su Salva.

Next, you can insert the string variable containing the cell address into the Specific cell field of actions
related to cell operations. Consulta Cell operations in Excel advanced alla pagina 1551.
Using Get cell color action
Use the Get cell color action to get the color of the background or text in a cell.
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This action retrieves the color of a cell as RGB values. For example, if the background or text in a cell is of
red color, the value retrieved is 255,0,0.
1. Double-click or drag the Get cell color action from the Excel node in the Actions palette.
2. Select the Background color option to get the background color of the cell or the Text color option

to get the color of the text.
3. Select the Active cell option to get the color from the current active cell or the Specific cell option

to get the color from the address of the cell you have specified.
4. Select a variable from the Assign the output to variable list to assign the address of the empty cell

to the variable you have selected from the list.
5. Select the string variable you want to use to store the address of the empty cell from the Assign the

output to variable list.
La  mostra un nome descrittivo predefinito della variabile. If you create several output variables,
subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.

6. Enter the name of the session used to open the workbook with the Open .
7. Fai clic su Salva.

Get multiple cells action
The Get multiple cells action in the Excel advanced package enables you to retrieve the values from the
cells in a Microsoft Excel spreadsheet and stores them in a table variable.

Impostazioni

This  retrieves cell values as string data types. It supports Excel cell formats, including Number,
Percentage, Currency, Scientific, and Date. For example, a value from a cell of Currency formatting retains
the currency symbol when passed to a table or record variable.

Nota:  You must convert the values to perform non-string operations.

• Select the Multiple cells option to retrieve values from a range of cells, or select All cells to retrieve
values from all the cells.

Nota:  When you run a bot with the Excel Advanced > Cell range option, ensure that you use a
numeric value as the last character in the From cell and To cell fields (for example, testa1). The last
character cannot be an alpha character.

• Scegli dall'opzione Leggi per leggere il testo visibile o il valore della cella.
Ad esempio, se la cella ha il 70% come contenuto di cella, l'opzione Leggi valore cella leggerà il
valore come 70 ignorando il formato %, mentre l'opzione Leggi testo visibile leggerà il contenuto
come 70%.

Nota:  When you use the Read visible text option to process large data sets in Microsoft Excel
spreadsheets, the action consumes more time to process the data.

Recommendation:  Utilizza l'opzione Leggi valore cella poiché la lettura di un valore offre
prestazioni migliori rispetto alla lettura del testo visibile.

• Enter the name of the session used to open the workbook with the Open .
• Select a table variable to store the retrieved values in the Assign value to variable list. La  mostra un

nome descrittivo predefinito della variabile. If you create several output variables, subsequent variable
names are appended with a -1, -2, -3, and so on to avoid duplication.
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Using Get number of rows action
Use the Get number of rows action to get the number of rows that contain data.
To get the number of rows that are not empty or contain data, do the following:
1. Double-click or drag the Get number of rows action from the Excel node in the Actions palette.
2. Select the Index option to specify the number of the worksheet or the Name option to specify the

name of the worksheet from which you want to get the number or rows.
3. Select one of the following options:

• Non-empty rows: returns the total number of non-empty rows only.
• Total rows with data: returns the total number of rows including empty cells.

For example, consider the following illustration of an excel file:

The Non-empty rows returns the value 4, while Total rows with data returns the value 6.

4. Enter the name of the session used to open the workbook with the Open .
5. Select the number variable you want to use to store the output from the Assign to variable list.
6. Fai clic su Salva.

Get single cell action
The Get single cell action in the Excel advanced package enables you to retrieve the values from a single
cell in a Microsoft Excel spreadsheet or a CSV file and store them in a string variable.

Impostazioni

This  retrieves cell values as string data types. It supports Excel cell formats, including Number,
Percentage, Currency, Scientific, and Date. For example, a value from a cell of Currency formatting retains
the currency symbol when passed to a table or record variable.

Nota:  You must convert the values to perform non-string operations.

• Seleziona l'opzione Cella attiva per recuperare il valore dalla cella attiva o seleziona Cella specifica
per recuperare il valore da una cella specifica in un foglio di calcolo di Microsoft Excel.

• Scegli dall'opzione Leggi per leggere il testo visibile o il valore della cella.
Ad esempio, se la cella ha il 70% come contenuto di cella, l'opzione Leggi valore cella leggerà il
valore come 70 ignorando il formato %, mentre l'opzione Leggi testo visibile leggerà il contenuto
come 70%.

Recommendation:  Utilizza l'opzione Leggi valore cella poiché la lettura di un valore da una cella
offre prestazioni migliori rispetto alla lettura del testo visibile.

• Enter the name of the session used to open the workbook with the Open .
• Select a string variable to store the retrieved values in the Store cell contents to list. La  mostra un

nome descrittivo predefinito della variabile. If you create several output variables, subsequent variable
names are appended with a -1, -2, -3, and so on to avoid duplication.
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Nota:  If the character limit in a single cell of a Microsoft Excel spreadsheet exceeds 8200, then the bot
reads only the first 8200 characters. This behaviour is specific only to Microsoft Excel spreadsheet.

Example of using a conditional statement alla pagina 2058
.
Go to cell action
The Go to cell action in the Excel advanced package enables you to move the cursor to a specific cell in a
Microsoft Excel spreadsheet or a CSV file.

Impostazioni

• Seleziona l'opzione Cella specifica per indicare la cella specifica su cui desideri spostare il cursore o
seleziona un'opzione dall'elenco Cella attiva.

Nota:  Puoi immettere un intervallo di celle nel campo Cella specifica per selezionare l'intero
intervallo di celle. Ad esempio, per selezionare tutte le celle nella seconda riga e dalla prima alla terza
colonna, immetti A2:C2.

• Enter the name of the session used to open the workbook with the Open .

Go to next empty cell action
The Go to next empty cell action in the Excel advanced package enables you to find the next empty cell in
the current worksheet. You can specify whether to find the empty cell toward the left, right, up, or down.

Settings

• Select the Active cell or Specified cell option to specify the cell from which to start searching for the
empty cell. If you have selected the Specified cell option, specify the address of the cell in the field.

• Select the left, right, up, or down option to specify the direction in which to search for the next
empty cell.

• Enter the name of the session used to open the workbook with the Open .

Read cell formula action
The Read cell formula action in the Excel advanced package enables you to retrieve the formula available
in the Active cell or Specified cell and assign the output to a string variable. This action returns a blank
value if the specified cell does not contain a formula.

Impostazioni

• Enter the name of the session used to open the workbook with the Open .
• Seleziona l'opzione Cella attiva o Cella specifica per specificare la cella dalla quale leggere la

formula. Se hai selezionato l'opzione Cella specifica, devi specificare l'indirizzo della cella nel campo.
• Select a string variable to store the name of the formula from the Assign the output to variable

list. La  mostra un nome descrittivo predefinito della variabile. If you create several output variables,
subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.

Using the Replace action
Use the Replace action to find cells that contain a specific string and replace it with another string. This
action supports .xlsx, .xlsm, and .csv files.
1. Double-click or drag the Replace action from the Excel advanced node in the Actions palette.
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2. Select an option from the From list to specify a starting point of the cell range for search:
• Beginning: Starts the search from the beginning of the spreadsheet.
• End: Starts the search from the end of the spreadsheet.
• Active cell: Starts the search from the active cell in the spreadsheet.
• Specific cell: Enables you to specify the address of the cell from where you want to start the

search.

3. Select an option from the Till list to specify an end point of the cell range for search:
• Beginning: Ends the search at the beginning of the spreadsheet.
• End: Ends the search at the end of the spreadsheet.
• Active cell: Ends the search at the active cell in the spreadsheet.
• Specific cell: Enables you to specify the address of the cell where you want to end the search.

4. Specify the string you want to search for in the Find field.
5. Select from the following search options:

• By rows: Enables you to search by rows.
• By columns: Enables you to search by columns.
• Caso di corrispondenza: Only performs this action on cells that contain a string that matches the

uppercase and lowercase characters of the string you specified in the Find field.
• Match entire cell contents: Enables you to find only those cells that contain the entire string

you have specified in the Find field.

6. Select Replace with and specify the replacement string, or leave the field blank to replace the
matching cells with an empty character.

7. Enter the name of the session used to open the workbook with the Open .
8. Fai clic su Salva.

Set cell action
The Set cell action in the Excel advanced package enables you to set a value in the Active cell or Specific
cell in a Microsoft Excel spreadsheet or a CSV file. You can also use this action to set a formula.

Impostazioni

• Seleziona l'opzione Cella attiva o Cella specifica per specificare la cella in cui impostare il valore. If
you have selected the Specified cell option, specify the address of the cell in the field. You can use
the Set cell action to set or change the value of any Active cell or Specified cell cell value (including
the header row).

Nota:  Puoi immettere un intervallo di celle nel campo Cella specifica per impostare un valore
particolare in tutte le celle dell'intervallo. Ad esempio, per impostare un valore di 5 in tutte le celle nella
seconda riga e dalla prima alla terza colonna, immetti A2:C2.

• Inserisci il valore da impostare nel campo Valore cella.
• Enter the name of the session used to open the workbook with the Open .

Set cell formula action
The Set cell formula action in the Excel advanced package enables you to set a formula in the active cell or
a specific cell in a Microsoft Excel spreadsheet or a CSV file.
Per generare un numero casuale, utilizza l'action Numero > Casuale. Vedi Azione casuale.

© 2023 Automation Anywhere. All rights reserved.     1558



    Automation Anywhere - Crea

Impostazioni

• Seleziona l'opzione Imposta formula per la cella attiva o Imposta formula per la cella
specifica per specificare la cella in cui desideri impostare la formula. Se hai selezionato l'opzione
Imposta formula per la cella specifica, devi specificare l'indirizzo della cella nel campo.

• Immetti la formula da impostare nel campo Immetti la formula per la cella specifica.
• Enter the name of the session used to open the workbook with the Open .

Table operations in Excel advanced
The Excel advanced package contains various actions that you can use to automate tasks related to
table operations in a Microsoft Excel spreadsheet.

Table actions in the Excel advanced package

Nota:  Ensure that a table is available in the workbook. A worksheet that contains data in various rows
and columns is not considered as a table.

Il pacchetto Excel avanzato comprende le seguenti azioni:

Azione Descrizione

Elimina colonna tabella Vedi Delete table column action alla pagina 1559

Filtra tabella Consulta Using Filter table action alla pagina 1559.

Ottieni intervallo
tabella

Vedi Get table range action alla pagina 1560

Inserisci colonna di
tabella

Vedi Insert table column action alla pagina 1561

Ordina tabella Vedi Sort table action alla pagina 1561

Delete table column action
The Delete table column action in the Excel advanced package enables you to delete a column in a table.

Impostazioni

• Specify the Table name from which you want to delete a column.

Nota:  The table name is a string value. It is NOT a data table name. For information on how to
retrieve the Excel table name, see Rename an Excel table.

• Select the Name or Position to specify the name or position of the column to delete.
• Enter the name of the session used to open the workbook with the Open .

Using Filter table action
Use the Filter table action to filter data from a column in a table.
To filter data in a table, do the following:
1. Double-click or drag the Filter table action from the Excel node in the Actions palette.
2. Specify the name of the table from which you want to filter data in the Table name field.
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Nota:  The table name is a string value. It is NOT a data table name. For information on how to
retrieve the Excel table name, see .

3. Select the Column name to specify the name of the column or the Column position to specify the
position of the column that contains the data you want to filter.

4. Select the Number option if the column you have specified contains number data.
a) Select an option from the list to specify the operator you want to use to filter the data.

The following options are available:
• Equals: Filters the data that is equal to the value you have specified.
• Does not equal: Filters the data that is not equal to the value you have specified.
• Greater than: Filters the data that is greater than the value you have specified.
• Greater than or equal to: Filters the data that is greater than or equal to the value you

have specified.
• Less than: Filters the data that is less than the value you have specified.
• Less than or equal to: Filters the data that is less than or equal to the value you have

specified.
• Between: Filters the data that is between the two values you have specified.

Nota:  Apart from the Between option, you do not have to provide a value in the second field.
If you have provided a value in the second field, the system ignores that value when filtering the
data.

5. Select the Text option if the column you have specified contains textual data.
a) Select an option from the list to specify the operator you want to use to filter the data.

The following options are available:
• Equals: Filters the data that is equal to the value you have specified.
• Does not equal: Filters the data that is not equal to the value you have specified.
• Begins with: Filters the data that begins with the value you have specified.
• Ends with: Filters the data that ends with the value you have specified.
• Contains: Filters the data that contains the value you have specified.
• Does not contain: Filters the data that does not contain the value you have specified.

6. Enter the name of the session used to open the workbook with the Open .
7. Fai clic su Salva.

Get table range action
The Get table range action in the Excel advanced package enables you to get the range of a table available
in a worksheet and store the output in a string variable.

Impostazioni

• Specify the Table name for which you want to get the range.

Nota:  The table name is a string value. It is NOT a data table name. For information on how to
retrieve the Excel table name, see .

• Select the options to specify whether you want to include a header and pivot table in the range and a
variable to store the output. La  mostra un nome descrittivo predefinito della variabile. If you create
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several output variables, subsequent variable names are appended with a -1, -2, -3, and so on to
avoid duplication.

• Enter the name of the session used to open the workbook with the Open .

Insert table column action
The Insert table column action in the Excel advanced package enables you to insert a column in a table.

Impostazioni

• Specify the Table name in which you want to insert a column.

Nota:  The table name is a string value. It is NOT a data table name. For information on how to
retrieve the Excel table name, see .

• Specify the name of the column in the Column name field and the position where you want to insert
the column in the Column position field.

• Enter the name of the session used to open the workbook with the Open .

Sort table action
The Sort table action in the Excel advanced package enables you to sort the data in a column of a table.
This action enables you to sort numeric and text data.

Impostazioni

Sorts the data in a column of a table. This action enables you to sort numeric and text data.
• Specify the Table name for which you want to sort the data.

Nota:  The table name is a string value. It is NOT a data table name. For information on how to
retrieve the Excel table name, see .

• Select the Column name or Column position to specify the name or position of the column.
• Select an appropriate option from the Number or Text list to specify the sort order.
• Enter the name of the session used to open the workbook with the Open .

Importante:  Ensure that Microsoft Excel is set to the same language as that of the computer operating
system.

CSV operations in Excel advanced
You can use some of the actions available in the Excel advanced package to perform various operations
on a CSV file.

CSV actions in the Excel advanced package

The following table lists the actions that you can use with a CSV file:

Supported Not Supported

Apri Trova cella vuota successiva

Imposta cella Get cell colour

Vai alla cella Go to next empty cell
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Insert/Delete row column Esegui macro

Insert/Delete row column Scopri tutti i fogli di lavoro

Ottieni valore Hide row/column in selection

Trova/Sostituisci Unhide row/column in selection

Convert excel to pdf Accedi a cartella di lavoro protetta da password

Elimina celle Protect/Unprotect workbook

Imposta formula cella Table related commands

Crea cartella di lavoro Crea foglio di lavoro

You can use the Loop action to retrieve data from each row in a CSV file. You can also use any of the
above action that supports the use of a CSV file within a Loop action.

Nota:  All the other actions available in the Excel advanced package that are not listed in the above
table cannot be used with a CSV file.

File package
Automatizza varie operazioni relative ai file, come creazione, apertura, copia, rinomina e cancellazione di
un file, utilizzando le actions disponibili nel package File.
Utilizza le actions contenute nel package File singolarmente, per eseguire un'action una volta o in
un'action Loop per eseguire quell'action per ogni file disponibile in una cartella.

Actions nel package File

Nota:  Puoi utilizzare l'action Comprimi disponibile nel package Folder per comprimere un file. Consulta
Zip action alla pagina 1571.

Il package File include le seguenti actions:

Action Descrizione

Assegna Vedi Assign action alla pagina 1563

Copia file desktop Consulta Using Copy Desktop file action for file alla pagina 1563.

Crea Vedi Crea action alla pagina 1564

Copia file Control
Room

Vedi Copy Control Room file action alla pagina 1566

Crea collegamento .
Vedi Create shortcut action alla pagina 1570

Crea un collegamento
simbolico

Vedi Create symbolic link action alla pagina 1570

Elimina Consulta Using Delete action for file alla pagina 1565.

Get name Vedi Get name action alla pagina 1566
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Action Descrizione

Get path Vedi Get path action alla pagina 1566

Apri Vedi Open action alla pagina 1567

Stampa Consulta Using Print action for file alla pagina 1567.

Stampa più file Consulta Using Print multiple files action alla pagina 1568.

Rinomina Consulta Using Rename action for file alla pagina 1569.

Riferimenti correlati
If package alla pagina 1625
Utilizza le actions nel package If per controllare la sequenza di esecuzione in base a una o più condizioni di
un'attività.
Loop package alla pagina 1681
Utilizza il Loop Pacchetto per eseguire una sequenza di actions ripetutamente per un numero specifico di
volte o fin quando una condizione specifica non sarà soddisfatta.
Variables overview alla pagina 2022
Automation 360 offers a variety of variables, each designed to hold specific types of data and is intended
for specific use. Use the topics below to learn more about each variable and how to use them.

Assign action
The Assign action in the File package enables you to assign a file from the Control Room , Desktop, or an
existing File variable to a user-defined File variable.

Impostazioni

Assigns a file from the Control Room , Desktop, or an existing File variable to a user-defined File variable.

Using Copy Desktop file action for file
Use the Copy Desktop file action to copy an existing file from Desktop to another location. This action
enables you to copy a file based on its size and the date it was created or modified.
To copy an existing file, follow these steps:
1. In the Actions palette, from the File package, double-click or drag the Copy Desktop file action.
2. From the Source file field select one of the following options:

• Specific: Specify the name and location of the file.
• For Regex: Specify the source folder path.

You can use a regular expression (regex) in your source file or folder path to support a pattern-
based search. Seleziona l'espressione regolare come Stringa o Modello per ogni condizione di
espressione regolare e immetti il valore.
For example, if want to copy, delete, rename or print multiple files from your source folder using
pattern based search, use regular expressions either as a String and enter the value as My_ for all
file name starting with My_ or as a Pattern such as [a-z]{3}(.txt|xlxs) to retrieve files that
matches this pattern.

3. In the Destination file/folder field, specify the name of the file and location.
4. Select the Overwrite existing files check box to overwrite an existing file with the same name at

the specified location.
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• If the Overwrite existing files option is not selected, the system appends the name
of the copied file with a numeric value. For example, if you have copied a file named
June_Quarter_report.pdf and a file with the same name exists in the location
where you want to save the copied file, the system saves the copied file as Copy of
 June_Quarter_report.pdf for the first time. When you copy the same file in the same folder
for the second time, it saves the copied file as Copy (2) of June_Quarter_report.pdf. The
numeric value is incremented each time you copy a file with the same name when the overwrite
check box is not selected.

• If you want to copy a file that is already available in the destination folder where the source and
the destination folders are different and the Overwrite existing files check box is not selected,
then the system shows the following error message: Unable to copy file(s) <path
\filename> as the specified file(s) exists.

5. Select the Size check box to copy a file based on its size.
a) Select any of the following options from the list:

• Atleast: Copies a file only if the file size is more than the size you have specified.
• Atmost: Copies a file only if the file size is less than the size you have specified.
• Exact: Copies a file only if the file size is the same as the size you have specified.

b) Specify a value in the Size field.

6. Select the Date check box to copy a file based on the date it was created or modified.
a) Select one of the options from the list:

• Created: Enables you to copy a file based on the date it was created.
• Modified: Enables you to copy a file based on the date it was modified.

b) Select the Is within last option and specify a value in the field.
This option enables you to perform the operation on the file if it was created or modified within
the number of days you have specified. For example, if you specify 7 in the field, the system
performs the operation on the file if it was created or modified in the last 7 days.

c) Select the Is between option to specify a period.
This option enables you to specify a Start date and an End date for the period. For example, if
you specify 01/01/19 as the start date and 01/31/19 as the end date of the period, the system
performs the operation on the file if it was created or modified between this period.

Nota:  The Start date and End date are included in the period.

d) Select the Is before option and specify a value in the field.
This option enables you to perform the operation on the file if it was created or modified on or
before the date you have specified.

e) Select the On a date option and specify a date in the field.
This option enables you to perform the operation on a file if it was created or modified on the
date that you specified.

7. Fai clic su Salva.

Crea action
The Create action in the File package enables you to create a new file.
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Impostazioni

• Nel campo File, specifica il nome che include la posizione in cui archiviare il file.
• Nell'opzione Sovrascrivi un file esistente, seleziona un file esistente con lo stesso nome per

sovrascriverlo. Se i file esistenti non vengono sovrascritti, Control Room aggiunge il nome del nuovo file
con un valore numerico.

Using Delete action for file
Use the Delete action to delete a file. This action enables you to delete a file based on its size and the
date it was created or modified.
Follow these steps to delete a file:
1. In the Actions palette, double-click or drag the Delete action from the File package.
2. From the Source file field select one of the following options:

• Specific: Specify the name and location of the file.
• For Regex: Specify the source folder path.

You can use a regular expression (regex) in your source file or folder path to support a pattern-
based search. Seleziona l'espressione regolare come Stringa o Modello per ogni condizione di
espressione regolare e immetti il valore.
For example, if want to copy, delete, rename or print multiple files from your source folder using
pattern based search, use regular expressions either as a String and enter the value as My_ for all
file name starting with My_ or as a Pattern such as [a-z]{3}(.txt|xlxs) to retrieve files that
matches this pattern.

3. Select the Size check box to delete a file based on its size.
a) Select any of the following options from the list:

• Atleast: Deletes a file only if the file size is more than the size you have specified.
• Atmost: Deletes a file only if the file size is less than the size you have specified.
• Exact: Deletes a file only if the file size is the same as the size you have specified.

b) Specify a value in the Size field.

4. Select the Date check box to delete a file based on the date it was created or modified.
a) Select one of the options from the list:

• Created: Enables you to delete a file based on the date it was created.
• Modified: Enables you to delete a file based on the date it was modified.

b) Select the Is within last option and specify a value in the field.
This option enables you to perform the operation on the file if it was created or modified within
the number of days you have specified. For example, if you specify 7 in the field, the system
performs the operation on the file if it was created or modified in the last 7 days.

c) Select the Is between option to specify a period.
This option enables you to specify a Start date and an End date for the period. For example, if
you specify 01/01/19 as the start date and 01/31/19 as the end date of the period, the system
performs the operation on the file if it was created or modified between this period.

Nota:  The Start date and End date are included in the period.

d) Select the Is before option and specify a value in the field.
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This option enables you to perform the operation on the file if it was created or modified on or
before the date you have specified.

e) Select the On a date option and specify a date in the field.
This option enables you to perform the operation on a file if it was created or modified on the
date that you specified.

5. Fai clic su Salva.

Copy Control Room file action
The Copy Control Room file action in the File package enables you to copy a Control Room file to a specific
location.

Impostazioni

• Nel campo File di Control Room, specifica il file da copiare. Seleziona una delle seguenti opzioni per
copiare un file dall'archivio di Control Room:
• Percorso file statico: Permette di sfogliare l'archivio di Control Room e selezionare il file. Usa

questa opzione quando il percorso del file è statico.

Nota:  Quando si sfoglia l'archivio della Control Room utilizzando Percorso file statico, i file con
estensione .bot non vengono visualizzati.

• Percorso file dinamico: Permette di sfogliare l'archivio di Control Room e selezionare il file.
Inoltre, permette anche di inserire variabili in un percorso di file per copiare un file dall'archivio di
Control Room dove il percorso del file è dinamico. Puoi inserire una variabile contenente l'intero
percorso del file o parte di esso.
Ad esempio, C:\user\My Docs\test.csv o C:\user\My Docs\$fileName$

• Nel campo Percorso file di destinazione, indica il percorso della posizione nella quale desideri
salvare il file. Puoi inserire una variabile contenente l'intero percorso del file o parte di esso.
Ad esempio, C:\user\My Docs\test.csv o C:\user\My Docs\$fileName$

Nota:  Se la struttura della cartella non esiste già, il bot crea tutte le cartelle in base alle esigenze.

• Seleziona Vero o Falso, oppure inserisci una variabile booleana per specificare se sovrascrivere il file
esistente.

Get name action
The Get name action in the File package enables you to get the name of the file.

Impostazioni

Recupera il nome del file dalla Control Room, dal desktop o da una variabile di file esistente e memorizza il
nome del file in una variabile stringa di output selezionata.

Get path action
The Get path action in the File package enables you to get the path of the file.
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Impostazioni

Recupera il percorso del file dalla Control Room, dal desktop o da una variabile di file esistente e
memorizza il percorso del file in una variabile stringa di output selezionata.

Nota:  Quando si seleziona l'opzione Control Room per recuperare il percorso del file, il bot visualizza il
percorso locale del file Control Room scaricato.

Open action
The Open action in the File package enables you to open an existing file.

Impostazioni
Nel campo File, specifica il nome che include la posizione in cui archiviare il file.
Puoi usare un'espressione regolare (regex) o una ricerca basata su un modello per aprire un file esistente
corrispondente ai criteri di ricerca. Seleziona l'espressione regolare come Stringa o Modello per ogni
condizione di espressione regolare e immetti il valore.

Using Print action for file
Use the Print action to print a file. This action enables you to print a file based on its size and the date it
was created or modified.
Follow these steps to print a file:
1. In the Actions palette, double-click or drag the Print action from the File package.
2. In the File field, specify the name and location of the file.
3. Select the Size check box to print a file based on its size.

a) Select one of the options from the list:
• Atleast: Prints a file only if the file size is more than the size you have specified.
• Atmost: Prints a file only if the file size is less than the size you have specified.
• Exact: Prints a file only if the file size is the same as the size you have specified.

b) Specify a value in the Size field.

4. Select the Date check box to print a file based on the date it was created or modified.
a) Select any of the following options from the list:

• Created: Enables you to print a file based on the date it was created.
• Modified: Enables you to print a file based on the date it was modified.

b) Select the Is within last option and specify a value in the field.
This option enables you to perform the operation on the file if it was created or modified within
the number of days you have specified. For example, if you specify 7 in the field, the system
performs the operation on the file if it was created or modified in the last 7 days.

c) Select the Is between option to specify a period.
This option enables you to specify a Start date and an End date for the period. For example, if
you specify 01/01/19 as the start date and 01/31/19 as the end date of the period, the system
performs the operation on the file if it was created or modified between this period.

Nota:  The Start date and End date are included in the period.
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d) Select the Is before option and specify a value in the field.
This option enables you to perform the operation on the file if it was created or modified on or
before the date you have specified.

e) Select the On a date option and specify a date in the field.
This option enables you to perform the operation on a file if it was created or modified on the
date that you specified.

5. Fai clic su Salva.

Using Print multiple files action
Use Print multiple files to print multiple files based on the size and the date they were created or
modified.
Follow these steps to print multiple files:
1. In the Actions palette, double-click or drag the Print multiple files action from the File package.
2. In the Folder field, specify the name and location of the folder.
3. From the File type field, select String to specify the file type of your files or Regex

Use the regular expression in your source file or folder path to support pattern based search. Select
the regular expression (Regex) either as a String or Pattern for each regex condition and input the
regex value.
For example, you can use regular expressions either as a String and enter the value as My_ for all
file name starting with My_ or as a Pattern such as [a-z]{3}(.txt|xlxs) to retrieve files that
matches this pattern.

4. Select the Include subfolders check box to include all the subfolders in your selected folder.
5. Select the Size check box to print multiple files based on their size.

a) Select any of the following options from the list:
• Atleast: Prints multiple files only if the file size is more than the size you have specified.
• Atmost: Prints multiple files only if the file size is less than the size you have specified.
• Exact: Prints multiple files only if the file size is the same as the size you have specified.

b) Specify a value in the Size field.

6. Select the Date check box to print multiple files based on the date they were created or modified.
a) Select one of the options from the list:

• Created: Enables you to print multiple files based on the date they were created.
• Modified: Enables you to print multiple files based on the date they were modified.

b) Select the Is within last option and specify a value in the field.
This option enables you to perform the operation on the files if they were created or modified
within the number of days you have specified. For example, if you specify 7 in the field, the
system performs the operation on the files if they were created or modified in the last 7 days.

c) Select the Is between option to specify a period.
This option enables you to specify a Start date and an End date for the period. For example, if
you specify 01/01/19 as the start date and 01/31/19 as the end date of the period, the system
performs the operation on the files if they were created or modified between this period.

Nota:  The Start date and End date are included in the period.

d) Select the Is before option and specify a value in the field.
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This option enables you to perform the operation on the files if they were created or modified on
or before the date you have specified.

e) Select the On a date option and specify a date in the field.
This option enables you to perform the operation on a file if it was created or modified on the
date that you specified.

7. Fai clic su Salva.

Using Rename action for file
Use the Rename action to rename a file. This action enables you to rename a file based on its size and
the date it was created or modified.
To rename a file, follow these steps:
1. In the Actions palette, double-click or drag the Rename action from the File package.
2. From the Source file field select one of the following options:

• Specific: Specify the name and location of the file.
• For Regex: Specify the source folder path.

You can use a regular expression (regex) in your source file or folder path to support a pattern-
based search. Seleziona l'espressione regolare come Stringa o Modello per ogni condizione di
espressione regolare e immetti il valore.
For example, if want to copy, delete, rename or print multiple files from your source folder using
pattern based search, use regular expressions either as a String and enter the value as My_ for all
file name starting with My_ or as a Pattern such as [a-z]{3}(.txt|xlxs) to retrieve files that
matches this pattern.

3. In the New file name field, specify a new name for the file.
4. Select the Size check box to rename a file based on its size.

a) Select one of the options from the list:
• Atleast: Renames a file only if the file size is more than the size you have specified.
• Atmost: Renames a file only if the file size is less than the size you have specified.
• Exact: Renames a file only if the file size is the same as the size you have specified.

b) Specify a value in the Size field.
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5. Select the Date check box to rename a file based on the date it was created or modified.
a) Select any of the following options from the list:

• Created: Enables you to rename a file based on the date it was created.
• Modified: Enables you to rename a file based on the date it was modified.

b) Select the Is within last option and specify a value in the field.
This option enables you to perform the operation on the file if it was created or modified within
the number of days you have specified. For example, if you specify 7 in the field, the system
performs the operation on the file if it was created or modified in the last 7 days.

c) Select the Is between option to specify a period.
This option enables you to specify a Start date and an End date for the period. For example, if
you specify 01/01/19 as the start date and 01/31/19 as the end date of the period, the system
performs the operation on the file if it was created or modified between this period.

Nota:  The Start date and End date are included in the period.

d) Select the Is before option and specify a value in the field.
This option enables you to perform the operation on the file if it was created or modified on or
before the date you have specified.

e) Select the On a date option and specify a date in the field.
This option enables you to perform the operation on a file if it was created or modified on the
date that you specified.

6. Fai clic su Salva.

Create shortcut action
The Create shortcut action in the File package enables you to create a shortcut to a target file.

Impostazioni

Creates a shortcut to a file at a user-specified location. Il collegamento dipende dal file di origine, quindi
qualsiasi modifica apportata al file di origine sarà applicata anche al collegamento.
• Nel campo Posizione di destinazione, specifica il nome e la posizione.
• Nel campo Posizione collegamento, specifica il nome e la posizione.

Nota:  Gli utenti con un ruolo valido e l'autorizzazione richiesta possono creare un collegamento a un file
in una posizione specificata.

Create symbolic link action
The Create a symbolic link action in the File package enables you to create a symbolic link to a target file.

Impostazioni

Creates a symbolic link to a file at a user-specified location. Il collegamento dipende dal file di origine,
quindi qualsiasi modifica apportata al file di origine sarà applicata anche al collegamento.
• Nel campo Posizione di destinazione, specifica il nome e la posizione.
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• In the Symbolic link location field, specify the name and location.

Nota:  Gli utenti con il solo accesso admin possono creare un collegamento a un file in una posizione
specificata.

Folder package
Automate folder-related operations by using the actions available in the Folder package.

Actions nel package Folder

Il package Folder include le seguenti actions:

Action Descrizione

Comprimi Consulta Zip action alla pagina 1571.

Copy Consulta Copy action in Folder alla pagina 1572.

Crea See .Create action in Folder alla pagina 1573.

Estrai Consulta Unzip action alla pagina 1573.

Elimina Consulta Delete action in Folder alla pagina 1573.

Crea collegamento Consulta Create shortcut action alla pagina 1574.

Apri Consulta Open action in Folder alla pagina 1575.

Rinomina Consulta Rename action in Folder alla pagina 1575.

Crea un collegamento
simbolico

Consulta Create symbolic link action alla pagina 1576.

Zip action
The Zip action enables you to compress files and folders into a .zip format.
1. In the Actions  palette, double-click or drag the Zip action from the Folder package.
2. In the Specify file(s)/folder(s) to compress field, specify the location.
3. In the Specify file type(s) to compress field, select one of the following options:

• Stringa: Specify the file extension.
For example, you can specify .txt and .png to compress only text files and PNG images. The system
compresses the entire folder if you do not specify any file type. You can also specify the name of a
file to compress a specific file.

• Regex: Select the regular expression (regex) either as a String or Pattern for each reguar
expression condition and enter the value.
For example, you can use regular expressions either as a String and enter the value as My_ for all
file name starting with My_ or as a Pattern such as [a-z]{3}(.txt|xlxs) to retrieve files that
matches this pattern.

4. In the Specify destination filename and location field, specify the zip file name and location.
5. Select the Update only if newer check box to compress the files only if one or more files were

updated after the last compression.
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This option is useful when you are repeatedly compressing the same set of files and storing the output
zip file with the same name at the same location. For example, you compress five PDF files from the
Reports folder on a monthly basis and save the output zip file with the Monthly Report name in
the D: drive. When this option is selected, the system compresses the files only if one or more PDF
files are updated after the last compression.

6. Select the Delete original files check box if you want to delete the original files after they are
included in the zip file.

7. In the Compression list, select between Normal, Fast, and Superfast to specify the speed for
compression.

8. Opzionale: In the Password protection field, click one of the following tabs to set a password:
• Credenziale: To specify a stored password.
• Variabile: To set a variable for password.
• Stringa: To enter a password manually.

9. Fai clic su Salva.

Copy action in Folder
The Copy action enables you to copy an existing folder into a specific location.
1. In the Actions palette, double-click or drag the Copy action from the Folder package.
2. In the Source folder field, specify the name and location.
3. In the Destination folder field, specify the folder name and location to save the copied folder.
4. Select the Overwrite existing files/folders check box to overwrite existing folders with the same

name.
If this option is not enabled, the system appends a numeric value at the end of the file name. For
example, if you save the June_Quarter_report file in a location that has a file with the same
name, the system saves the file as June_Quarter_report_(1).pdf. The numeric value is
incremented each time you save the file as long as the option is enabled.

5. Opzionale: Select the Size check box to copy a folder based on its size.
a) Use the drop-down menu to select one of the following options:

• Atleast: Copies a folder only if the folder size is more than the size you have specified.
• Atmost: Copies a folder only if the folder size is less than the size you have specified.
• Exact: Copies a folder only if the folder size is the same as the size you have specified.

b) In the Size (KB) field, specify the folder size.

6. Opzionale: Select the Date check box to copy a folder based on the date.
a) Use the drop-down menu to select one of the following options:

• Created: To copy a folder based on the date it was created.
• Modified: To copy a folder based on the date it was modified.

b) Use the second drop-down menu to select one of the following additional options:
• Relative to runtime: To set the date in regards to the bot runtime.
• Between two dates: To specify the time period.

This option enables you to specify a Start date and an End date of the period. For example,
if you specify 01/01/19 and 01/31/19 as the start date and end date, the system performs
the operation on the folder if it was created or modified between these dates.

Nota:  The Start date and End date are included in the period.
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• On a date: To specify a particular date.
This option enables you to set a specific date that a folders was created or modified.

• Before a date: To specify a date prior to which the folders were created.
For example, if you set the date as 07/28/20, folders created or modified before this date are
selected
(Optional) Select the Including date check box if you want include the date you have
specified for the Before a date option.

7. Fai clic su Salva.

Create action in Folder
The Create action enables you to create a folder.

Impostazioni

• In the Folder field, specify the name and location.
Folder names cannot include system actions or device references such as AUX, CON, LPT, NUL, and
PRN.

• (Optional) Select the Overwrite an existing folder check box to overwrite an existing folder.

Nota:  If this option is not selected, the system appends the name of the new folder with a numeric
value.

Unzip action
The Unzip action enables you to extract compressed content (files and folders) into a specific location
from a .zip file.
1. In the Actions  palette, double-click or drag the Unzip action from the Folder package.
2. In the Zip file name with full path field, specify the name and location.
3. In the Extract to path field, specify the location.
4. Select the Replace existing file check box to overwrite the file.
5. Opzionale: In the Password to access zip file field, click one of the following tabs to set a

password:
• Credenziale: To specify a stored password.
• Variabile: To set a variable for password.
• Stringa: To enter a password manually.

6. Fai clic su Salva.

Delete action in Folder
The Delete action enables you to remove or delete folder from specific location.
1. In the Actions palette, double-click or drag the Delete action from the Folder package.
2. In the Folder field, specify the name and location.
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3. Opzionale: Select the Size check box to delete a folder based on its size.
a) Use the drop-down menu to select of the following options:

• Atleast: Deletes a folder only if the folder size is more than the size you have specified.
• Atmost: Deletes a folder only if the folder size is less than the size you have specified.
• Exact: Deletes a folder only if the folder size is the same as the size you have specified.

b) In the Size field, specify the folder size.

4. Opzionale: Select the Date check box to delete a folder based on the date it was created or modified.
a) Use the drop-down menu to select one of the following options:

• Created: To delete a folder based on the date it was created.
• Modified: To delete a folder based on the date it was modified.

b) Use the second drop-down menu to select one of the following additional options:
• Relative to runtime: To set the date in regards to the bot runtime.
• Between two dates: To specify the time period.

This option enables you to specify a Start date and an End date of the period. For example,
if you specify 01/01/19 and 01/31/19 as the start date and end date, the system performs
the operation on the folder if it was created or modified between these dates.

Nota:  The Start date and End date are included in the period.

• On a date: To specify a particular date.
This option enables you to set a specific date that a folders was created or modified.

• Before a date: To specify a date prior to which the folders were created.
For example, if you set the date as 07/28/20, folders created or modified before this date are
selected
(Optional) Select the Including date check box if you want include the date you have
specified for the Before a date option.

5. Fai clic su Salva.

Create shortcut action
The Create shortcut action enables you to create a shortcut of a folder at a specified location. As the
folder shortcut is dependent on the source folder, any changes to the source folder is applied to the
shortcut as well.

Impostazioni

• Use the Target location field to select one of the following tabs:
• Cartella desktop: Click Browse to select the folder that you want to create a shortcut for.
• Variabile: Enter or paste the filepath of the folder that you want to create a shortcut for.

• Use the Shortcut location field to select one of the following tabs:
• Cartella desktop: Click Browse to select the folder where the folder shortcut must be created.
• Variabile: Enter the filepath where the folder shortcut must be created.
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Nota:  Only the users with administrator role can create a shortcut of the source folder at a specified
location.

Open action in Folder
The Open action enables you to open a folder from a specific location.

Impostazioni

• Use the Folder field to specify the filepath of the folder you want to open.
• (Optional) Click the Insert a value icon to select a variable.

Rename action in Folder
The Rename action enables you to rename an existing folder.
1. In the Actions palette, double-click or drag the Rename action from the Folder package.
2. In the Folder field, specify the name and location.
3. In the New folder name field, specify a new name.
4. Select the Size check box to rename a folder based on its size.

a) Select any of the following options from the list:
• Atleast: Renames a folder only if the folder size is more than the size you have specified.
• Atmost: Renames a folder only if the folder size is less than the size you have specified.
• Exact: Renames a folder only if the folder size is the same as the size you have specified.

b) In the Size field, specify the folder size.

5. Select the Date check box to rename a folder based on the date it was created or modified.
a) Select any of the following options from the list:

• Created: To rename a folder based on the date it was created.
• Modified: To rename a folder based on the date it was modified.

b) Use the second drop-down menu to select one of the following additional options:
• Relative to runtime: To set the date in regards to the bot runtime.
• Between two dates: To specify the time period.

This option enables you to specify a Start date and an End date of the period. For example,
if you specify 01/01/19 and 01/31/19 as the start date and end date, the system performs
the operation on the folder if it was created or modified between these dates.

Nota:  The Start date and End date are included in the period.

• On a date: To specify a particular date.
This option enables you to set a specific date that a folders was created or modified.

• Before a date: To specify a date prior to which the folders were created.
For example, if you set the date as 07/28/20, folders created or modified before this date are
selected
(Optional) Select the Including date check box if you want include the date you have
specified for the Before a date option.
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6. Fai clic su Salva.

Create symbolic link action
The Create symbolic link action enables you to create a symbolic link to a folder at a specified location.
As this link is dependent on the source folder, any changes you make to the source folder is applied to the
symbolic link.

Impostazioni

• Use the Target location field to select one of the following tabs:
• Cartella desktop: Click Browse to select the folder that you want to create a shortcut for.
• Variabile: Enter or paste the filepath of the folder that you want to create a shortcut for.

• Use the Symbolic link location field to select one of the following tabs:
• Cartella desktop: Click Browse to select the folder where the folder shortcut must be created.
• Variabile: Enter the filepath where the folder shortcut must be created.

Nota:  Only the users with administrator role can create a shortcut of the source folder at a specified
location.

FTP / SFTP package
Use the FTP / SFTP package to automate FTP / SFTP operations.
An FTP/SFTP server hosts the files to share. The client accesses, downloads, or uploads files to the server.
The transfer of data between the client and server is done using a TCP/IP network, which is the standard
protocol of communication over the internet.
• The following are some forms of authentication for an FTP server:

• User credentials: Requires an FTP username and password.
• Anonymous: This form of authentication is enabled on sites where files are available for public

access and the users need not identify themselves to the server.
• Key-based: SFTP authentication is usually done with a private and public key. The key pair is

automatically generated by the computer. The private key is kept with the SFTP client and the
corresponding public key with the SFTP server. When establishing a connection, the client shares the
private key to be matched with the corresponding public key on the server.

• FTP can run in active or passive transfer mode.
• In the active mode, the client informs the server about the port used for listening and starts listening

for incoming data connections from the server.
• In the passive mode, the client receives a server IP address and server port number from the

server. The client opens a data connection to the server IP address and server port number that are
received. Most organizations prefer the passive mode because it involves less or no alterations to the
firewall settings.

• FTP supports binary and ASCII file transfer types:
• Use the binary option when transferring executable files.
• Use the ASCII option when transferring text files.
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Prima di iniziare

Perform the following actions within the FTP / SFTP package.
1. Establish a connection with the FTP/SFTP server using the Connect action. When establishing a

connection, associate the FTP/SFTP server details with a session name. Use the same session name
for all corresponding actions.

2. Use the FTP/SFTP actions to automate a task. The actions enable you to perform following tasks:
• Upload, download, delete, or rename files.
• Upload, download, create, or delete folders.
• Navigate to the parent folder or a specific folder.

3. After you have automated the tasks related to FTP / SFTP, terminate the connection to the server
using the Disconnect action.

Nota:  SFTP with SSH1 protocol is no longer supported by SFTP.

Actions nel package FTP / SFTP

Il package FTP / SFTP include le seguenti actions:

Nota:  Regarding the use of a semicolon (;) in folder or file names, the following guidelines apply:
• You can use a semicolon (;) in the folder name for the following actions: Delete or Create folder
• You must not use a semicolon (;) in the folder or file name for other actions, such as the following:

Change folder, Delete files, Get files, Get folder, Put files, Put folders, and Rename files

Action Descrizione

Cambia cartella Consulta Change folder action alla pagina 1577.

Connetti Consulta Connect action alla pagina 1578.

Create folder Consulta Create folder action alla pagina 1579.

Elimina cartella Consulta Delete folder action alla pagina 1580.

Elimina i file Consulta Delete files action alla pagina 1580.

Disconnetti Consulta action Disconnetti alla pagina 1580.

Ottieni le cartelle Consulta Get folders action alla pagina 1580.

Ottieni i file Consulta Get files action alla pagina 1581.

Inserisci le cartelle Consulta Put folders action alla pagina 1581.

Inserisci i file Consulta Put files action alla pagina 1581.

Rinomina i file Consulta Rename files action alla pagina 1582.

Change folder action
The Change folder action enables you to navigate to either a parent folder or a specific folder on an FTP/
SFTP server.

© 2023 Automation Anywhere. All rights reserved.     1577



    Automation Anywhere - Crea

Impostazioni

• In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

• Use the Navigate to field to select one of the following options:
• Go to parent folder
• Specific folder

Ensure that you enter the complete folder path when you select the Specific folder option.

Connect action
The Connect action enables you to establish a connection with an FTP/SFTP server that you want to use
for automating tasks. Questa deve essere la prima azione utilizzata per automatizzare un'attività correlata
a FTP/SFTP.
Specifica i dettagli del server FTP/SFTP e associalo a un nome di sessione. Utilizza il nome di sessione
fornito in questa action nelle altre actions, per non dover fornire di nuovo i dettagli del server di database
in tali actions.
1. Double-click or drag the Connect action in the FTP/SFTP node in the Actions palette.
2. In the FTP/SFTP Session name field to enter a name for the session.
3. In the Server name field, enter the FTP/SFTP server name.
4. In the Port field, enter the FTP/SFTP server port number.
5. Use the Server type filed to select one of the following server type:

Tipo di server Fasi

FTP Tipo di autenticazione: Puoi scegliere di autenticarti tramite Nome
utente e password o di accedere come Anonimo. Se scegli Nome
utente e password, compila questi campi:
• In Nome utente e password, seleziona Credenziale, Variabile o

Stringa non sicura.
• Immetti i valori nei campi Nome utente e Password.

Se scegli di autenticarti utilizzando le credenziali utente (nome utente
e password), immetti un Credential Vault per la sicurezza avanzata o
immetti il valore direttamente nel campo Stringa non sicura.

Modalità di trasferimento: seleziona la modalità di trasferimento tra
Attiva e Passiva.
Tipo di trasferimento: Per trasferire file tra server e client, seleziona il
tipo da utilizzare tra Binario e ASCII.
Facoltativo: immetti il percorso della directory predefinita sul server FTP.
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Tipo di server Fasi

FTP Secure Tipo di autenticazione: Puoi scegliere di autenticarti tramite Nome
utente e password o di accedere come Anonimo. Se scegli Nome
utente e password, compila questi campi:
• In Nome utente e password, seleziona Credenziale, Variabile o

Stringa non sicura.
• Immetti i valori nei campi Nome utente e Password.

Se scegli di autenticarti utilizzando le credenziali utente (nome utente
e password), immetti un Credential Vault per la sicurezza avanzata o
immetti il valore direttamente nel campo Stringa non sicura.

FTP sicuro Scegli Chiave e nome utente, Chiave e credenziali o Credenziali per
autenticare l'utente:
• Chiave e nome utente: seleziona il File chiave privata da File

Control Room, File desktop o Variabile. To enter the Username,
select from the following options:Credential, variable, , and Insecure
string.

• Chiave e credenziali: seleziona il File chiave privata da File
Control Room, File desktop o Variabile. To enter the Username,
select from the following options:Credential, variable, , and Insecure
string.

• Nota:  Verifica che il server SFTP disponga di un file delle chiavi
pubbliche corrispondente.

• Credenziali: Seleziona Credenziale, Variabile o Stringa non sicura
per immettere il valore nei campi Nome utente e Password.
Se scegli di autenticarti utilizzando le credenziali utente (nome utente
e password), immetti un Credential Vault per la sicurezza avanzata o
immetti il valore direttamente nel campo Stringa non sicura.

6. Opzionale: Select Reconnect if connection fails check box.
Use the following drop-down menus to select additional options while reconnecting:
a) Attempts: Select the number of times the action must attempt to reconnect.
b) Time between attempts: Select the time lapse between each attempt.

Nota:  Se la connessione non riesce a causa di credenziali errate, l'action non tenterà di riconnettersi.

7. Fai clic su Salva.

Create folder action
The Create folder action enables you to create a folder on an FTP/SFTP server.

Impostazioni

• In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.
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• Use the Remote folder field to specify the filepath where the folder must be created on the FTP/SFTP
server.

Nota:  The system encounters an error if a folder with the same name exists in the parent folder.

Delete folder action
The Delete folder action enables you to remove or delete a folder (including all the subfolders and files
within it) from an FTP/SFTP server.

Impostazioni

• In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

• Use the Remote folder field to specify the filepath of the folder that must be deleted from the FTP/
SFTP server.

Delete files action
The Delete files action enables you to remove or delete files from an FTP/SFTP server.

Impostazioni

• In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

• Use the Remote files field to specify the filepath of the file(s) that must be deleted from the FTP/SFTP
server.

action Disconnetti
The Disconnect action enables you to close or terminate an active connection to the FTP/SFTP server.

Impostazioni

In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

Get folders action
The Get folders action enables you to download a folder on an FTP/SFTP server into a client machine.

Impostazioni

• In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.
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• Use the Remote folder field to enter the filepath of the folders on the remote FTP/SFTP server that
you want to download.
Specify filters using wildcard characters to download only specific types of files.

• Use the Local folder field to enter the location on your local device where you want to download the
folders from the FTP/SFTP server.

• (Optional) Click the Select date drop-down menu to specify folders based on the date they were
modified or created.

Get files action
The Get files action enables you to download files from a remote FTP/SFTP folder to a specific location on
a client machine.

Impostazioni

• In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

• Use the Remote files field to enter the filepath of the files on the remote FTP/SFTP server that you
want to download.
Specify filters using wildcard characters to download only specific types of files.

• Use the Local folder field to enter the location of the client machine where you want to download the
files from the FTP/SFTP server.

• Use the Transfer Type to select one of the following formats of the download files:
• Binary
• ASCII

• (Optional) Use the Select date drop-down menu to specify files based on the date they are modified
or created.

Put folders action
The Put folders action enables you to upload a folder from a client machine to the FTP/SFTP server.

Impostazioni

• In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

• Use the Local folder field to enter the location of the client machine from where you want to upload
folder to FTP/SFTP server.
Specify filters using wild card characters to restrict uploads to specific types of files.

• (Optional) Use the File types field to specify the type of files that must be included in the upload
folder.

Put files action
The Put files action enables you to upload one or more files from a client machine to an FTP/SFTP server.
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Impostazioni

• In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

• Use the Local files field to enter the location of the client machine from where you want to upload files
to FTP/SFTP server.
Specify filters using wild card characters to restrict uploads to specific types of files.

• Use the Transfer type field to select one of the following upload format of the files:
• Binary
• ASCII

Rename files action
The Rename files action enables you to edit or change the name of files on an FTP/SFTP server.

Impostazioni

• In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

• Use the Remote file field to specify the filepath of the file that you want to rename.
• Use the New remote file field to enter the new name of the file.

Fuzzy match package
Use the Fuzzy match action to compare the values of two strings or files for similarity. This action returns
a decimal value; the closer the value to 1.0, the greater the similarity between the two strings.

Importante:  This is a beta package and is currently not available with the Automation 360 Enterprise
and Cloud editions.

Use this action to automate the process of evaluating strings of data for similiarity. For example, you have
an automation sequence in which a bot extracts data from invoices, searches a database for the company
record, and updates the record with data from the invoice. Use the Fuzzy match action to handle two
possible scenarios:
• A mistake occurs at the extraction step where a letter is incorrectly extracted. Instead of Apple, the bot

extracts App1e, with a numerical one instead of the letter l.
• There is a small variation between the company name on the invoice and in the database. The invoice

contains the company name Apple Inc, but the database has a record for the company name Apple.

Genesys package
Automate the repetitive tasks related to onboarding and updating the details of contacts by using the
actions in the Genesys package.
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Intended use

The actions in the Genesys package are intended for use with the Automation Anywhere for Genesys
integration. Currently, data cannot be passed directly from the integration to Genesys. These actions
require a source data file to call from. You can then choose to manipulate the data by using variables or
another worksheet before passing the final changes back to the Genesys source file. The actions included
in this package are intended to offer automated solutions for common tasks.

Actions in the Genesys package

Use the following actions in the Genesys package to automate common onboarding and updating tasks.

Azione Descrizione

Autenticazione The OAuth authenticate action calls your Genesys credential
token and is required for the bot to connect with the API.
• Immetti l'URL dell'ambiente cloud Genesys.
• Select how you would like your credentials passed.

• Use Credential to pick a preconfigured credential locker.
• Use Variable to select a preconfigured credential variable.
• Use Insecure string to enter your credential in the field

without encryption.

• Immetti le credenziali richieste per accedere all'ambiente per il
Client ID.

• Select how you would like your secret passed.
• Use Credential to pick a preconfigured credential locker.
• Use Variable to select an established variable.
• Use Insecure string to enter your secret in the field

without encryption.

• Immetti il codice segreto del client OAuth utilizzato per la
concessione delle credenziali per il Client segreto.

• Immetti il Nome sessione per le modifiche all'archivio.

Divisione Perform actions related to division details, such as adding and
removing roles to a division. Division palette alla pagina 1584

External contact Perform actions such as adding and updating contact details.
External contact palette alla pagina 1586

Gruppo Perform actions such as adding and deleting members from a
group. Group palette alla pagina 1587

Lingua Perform actions such as adding, listing, and removing routing
languages. Language palette alla pagina 1588

External organization Perform actions such as creating, updating, and deleting
organizations. External organization palette alla pagina 1589

Telefono Perform actions such as assigning, creating, and removing phone
records. Phone palette alla pagina 1591
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Azione Descrizione

Code Perform actions such as adding and removing selections from
queues. Queues palette alla pagina 1592

Ruolo Perform actions such as adding, setting, and removing roles for
users. Role palette alla pagina 1593

Skill Perform actions such as adding, replacing, and removing skills. Skill
palette alla pagina 1595

Utente Perform actions such as creating, deleting, and getting users. User
palette alla pagina 1597

Division palette
The Genesys command package offers a palette of actions to detail and access the role of divisions.

Division palette for Genesys

A division is a way to group and segregate objects while keeping them inside the same organization.
For example, you can organize divisions by business unit, country, and office location and then assign
respective objects that are configured for each individual division. After you organize and configure
divisions, you can use roles to grant user access to division configurations and thus the objects within the
respective division.
The Genesys package includes the following division actions:

Azione Descrizione

Add role into division Detail a role for a division.
• Enter the ID of the user account for Internal user ID.
• Enter the ID of the division for Division ID.
• Enter the role of the division for Role ID.
• Immetti il Nome sessione per le modifiche all'archivio.

Bulk-add roles into division Detail multiple roles in a division.
• Select how data is organized within your Division dataset.

• If using a Table:
• Click Edit table to create your table.
• Enter the data into the cells of your table.

• If using Variable, then select the established variable of the
data to be added to the division.

• Select the proper ID of the first, second, and third columns.
These must correspond with the User, Role, and Division IDs of
your dataset.

• Immetti il Nome sessione per le modifiche all'archivio.
• Optionally, Choose a variable where the data will be saved.
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Azione Descrizione

Bulk-remove roles for division Delete multiple roles from a division.
• Select how data is organized within your Division dataset.

• If using a Table:
• Click Edit table to create your table.
• Enter the data into the cells of your table.

• If using Variable, then select the established variable of the
data to be removed from the division.

• Select the proper ID of the first, second, and third columns.
These must correspond with the User, Role, and Division IDs of
your dataset.

• Immetti il Nome sessione per le modifiche all'archivio.
• Optionally, Choose a variable where the data will be saved.

Bulk-replace roles in division Replace multiple roles in a division.
• Select how data is organized within your Division dataset.

• If using a Table:
• Click Edit table to create your table.
• Enter the data into the cells of your table.

• If using Variable, then select the established variable of the
data to replace in the division.

• Select the proper ID of the first, second, and third columns to
map the corresponding User, Role, and Division IDs of your
dataset.

• Immetti il Nome sessione per le modifiche all'archivio.
• Optionally, Choose a variable where the data will be saved.

Get the home division Retrieve the home division for the organization.
• Immetti il Nome sessione per le modifiche all'archivio.
• Select how the outcome data will be saved.

• If using Multiple variables, use the following steps for
each variable:
• Click Add variable mapping.
• Enter the Key of the variable.
• Choose a variable where the data will be saved.
• Click Add for this division to be saved to the configured

variable.

• If using a Dictionary variable, then select the established
variable.
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Azione Descrizione

List/search divisions Retrieve the home division for the organization.
• Optionally, enter the Division name.
• Immetti il Nome sessione per le modifiche all'archivio.
• Choose a variable where the data will be saved.

Remove role from division Delete a grant of a role in a division.
• Enter the ID of the user account for Internal user ID.
• Enter the ID of the division for Division ID.
• Enter the role of the division for Role ID.
• Immetti il Nome sessione per le modifiche all'archivio.

External contact palette
The Genesys package offers a palette of actions to detail and access data for external contact records.

External Contact palette for Genesys

An external contact includes a comprehensive repository of data relevant to making contact with an
individual or external organization. From an external contact record, you have a streamlined view of all
contact and organization data.
Detail as much or as little relevant data beyond the first and last name of the contact. Optional data can
include salutation, title, external organization ID, multiple phones, addresses, and an external system URL.

Nota:  When providing the organization ID that represents an external organization in Genesys, the
contact will be linked to that org.

The Genesys package includes the following external contact actions:

Azione Descrizione

Create contact Add details of a new contact.
• Enter the first name.
• Enter the last name.
• Enter optional data.
• Select Yes or No for the Survey opt out.
• Immetti il Nome sessione per le modifiche all'archivio.
• Optionally, Choose a variable where the external contact ID

will be saved.

Delete contact Delete an external contact.
• Enter the External contact ID.
• Immetti il Nome sessione per le modifiche all'archivio.
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Azione Descrizione

List/search contacts Find and view specific contacts that match your search query.
• Optionally, enter the External contact ID.
• Optionally, enter keywords for your Search query.
• Immetti il Nome sessione per le modifiche all'archivio.
• Choose a variable where the outcome data will be saved.

Update contact Update the details for an external contact.
• Enter the External contact ID of the record that you want to

update.
• Enter the first name
• Enter the last name
• Enter optional data.
• Select Yes or No for Survey opt out.
• Immetti il Nome sessione per le modifiche all'archivio.

Group palette
The Genesys package offers a palette of actions to detail and access data for grouping records.

Group palette for Genesys

Groups organize people with similar traits. For example, users that share skills, locations, or other
information maintained in Genesys Cloud can be grouped for organizational functions.
Groups can be work-related or social to assist in project and priorities. Examples of groups include the
following:
• Subject Matter Experts (SMEs): A group of SMEs can let others in the organization know the most

current information.
• Projects: Groups related to projects streamline information to the team and expedite updates and

planning.
• Locations: Groups can simplify communication for geographical updates and events.

The Genesys package includes the following group actions:

Azione Descrizione

Bulk-add members into group Add multiple members into a group.
• Enter the Group ID.
• Select how the data will be entered to begin adding user data.

• If using a List:
• Select the data Type.
• Enter the Value of the data in the list.

• If using Variable, then select the established variable of the
data to be entered in the group.

• Immetti il Nome sessione per le modifiche all'archivio.
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Azione Descrizione

Delete member Delete a member from a group.
• Enter the Group ID.
• Select how the data will be entered to begin deleting user data

from the group.
• If using a List:

• Select the data Type.
• Enter the Value of the data in the list.

• If using Variable, then select the established variable of the
data to be deleted from the group.

• Immetti il Nome sessione per le modifiche all'archivio.

List groups View all groups.
• Immetti il Nome sessione per le modifiche all'archivio.
• Choose a variable where the outcome data will be saved.

List members List all the members in a specific group.
• Enter the Group ID.
• Immetti il Nome sessione per le modifiche all'archivio.
• Choose a variable where the outcome data will be saved.

Language palette
The Genesys package offers a palette of actions to detail languages for call-routing purposes.

Language palette for Genesys

Languages are separate from Automatic Call Distribution (ACD) skills. For example, Genesys Cloud will
prioritize an agent that speaks the language requested by the customer over an agent who is more skilled
but cannot speak the requested language. An agent that cannot speak the language of the customer does
not receive that interaction regardless of ACD skill.
Attributing users with languages empowers your team to handle diverse calls with effective
communication. The Genesys package includes the following language actions:

Azione Descrizione

Add routing language Add a routing language to a user.
• Enter a unique user ID for the Internal user ID.
• Enter the Language ID that is to be added to the user.
• Enter the user's language Proficiency with a value of 0-5. Zero

is low proficiency.
• Immetti il Nome sessione per le modifiche all'archivio.
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Azione Descrizione

Bulk-add routing languages to
user

Attribute multiple users with languages.
• Select how the dataset will be entered.

• If using a Table:
• Click Edit table to create your table.
• Enter the data of the cells for your table.

• If using Variable, then select the established variable of the
data to be added to the user.

• Select the proper ID of the first, second, and third columns to
map the corresponding User, Role, and Division IDs of your
dataset.

• Immetti il Nome sessione per le modifiche all'archivio.
• Optionally, Choose a variable where the outcome data will be

saved.

List user's routing languages List the languages attributed to a user.
• Enter the unique user ID for the Internal user ID.
• Immetti il Nome sessione per le modifiche all'archivio.
• Choose a variable where the outcome data will be saved.

List all routing languages List all the supported languages.
• Immetti il Nome sessione per le modifiche all'archivio.
• Choose a variable where the outcome data will be saved.

Remove routing language
from user

Remove an attributed language from a user.
• Enter the unique user ID for the Internal user ID.
• Enter the Language ID to be removed.
• Immetti il Nome sessione per le modifiche all'archivio.

External organization palette
The Genesys package offers a palette of actions to detail and access data for external organization records.

External organization palette for Genesys

External organizations are your customers, partners, and other businesses that you interact with. An
organization (org) can also be considered an account and is related to External Contacts in that contacts
belong to an org. Simply put, contacts are customers and the relationship defines what business a contact
might be calling about. Allowing an agent to view customer information and the org of the customer help
the agent to quickly understand the relevant business details to best serve their needs. Therefore, having
the org details available to bots can enable workflows, such as automatically importing account data into
Genesys from other systems, using Genesys Org details to look up open cases for the account from an
external case management tool, and so on.
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Similar to contacts, you can detail as much or as little relevant data beyond the name of the org. Optional
data can include company type, industry, multiple phones, addresses, tags, and websites. The Genesys
package includes the following external organization actions:

Azione Descrizione

Create organization Create the initial external organization record.
• Enter the Name of the org.
• Enter the optional data.
• Select whether the org approved to be contacted through

Phone SMS.
• Select whether the org approved to be contacted through Fax

SMS.
• Immetti il Nome sessione per le modifiche all'archivio.
• Optionally, Choose a variable where the org ID can be saved.

Delete organization Delete a record of an external organization.
• Enter the ID for the external organization.
• Immetti il Nome sessione per le modifiche all'archivio.

Get organization Call the details of an external organization record.
• Enter the ID for the external organization.
• Immetti il Nome sessione per le modifiche all'archivio.
• Select how the outcome data will be saved.

• If using Multiple variables, use the following steps for
each variable:
• Click Add variable mapping.
• Enter the Key of the variable.
• Choose a variable where the data will be saved.
• Click Add for this data to be saved to the configured

variable.

• If using a Dictionary variable, then select the established
variable where the outcome data can be saved.

List/search organizations Call a list of external organizations that match your search query.
• Optionally, enter keywords for your Search query.
• Immetti il Nome sessione per le modifiche all'archivio.
• Choose a variable where the outcome data will be saved.

Update organization Update an external organization record with new or additional data.
• Enter the ID of the external organization record.
• Enter the Name of the org.
• Enter the optional data.
• Select whether the org approved contact through Phone SMS.
• Select whether the org approved contact through Fax SMS.
• Immetti il Nome sessione per le modifiche all'archivio.
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Phone palette
The Genesys package offers a palette of actions to detail and access data for phone records.

Phone palette for Genesys

Genesys Cloud supports the WebRTC technology with the Genesys Cloud WebRTC phone. The Genesys
Cloud WebRTC phone runs from a browser, that is, there are no special hardware requirements or software
to download. When the Genesys Cloud WebRTC phone is enabled, you can immediately use it to make and
receive calls. It is an important part of the onboarding process that phones be created and assigned to
agents so that calls are effectively routed from the queue to agents.
Configuring a Genesys Cloud WebRTC phone is a two-step operation. First, base settings must be
created and configured by the admin and must already be established. Second, the phone is created and
configured to retrieve established base settings. These secondary tasks can be automated. The Genesys
package includes the following phone actions:

Azione Descrizione

Assign phone Assign a phone line to a user.
• Enter a unique user ID for the Internal user ID.
• Enter a line ID to assign the Phone's line ID to the user.
• Immetti il Nome sessione per le modifiche all'archivio.

Create a phone Create a phone record.
• Enter a Name for the phone.
• Enter the Phone base setting ID to route the preconfigured

base settings.
• Enter the Site ID where the phone is located.
• Enter the Web rtc user ID of the WebRTC user.
• Immetti il Nome sessione per le modifiche all'archivio.
• Optionally, Choose a variable for the Phone ID.
• Optionally, Choose a variable for the Phone's line ID.

List phone base settings Get a list of phone base settings.
• Optionally, enter a Name for the list.
• Immetti il Nome sessione per le modifiche all'archivio.
• Choose a variable where the outcome data can be saved.

List/search phones Get a list of phones.
• Optionally, enter a Name for the list.
• Immetti il Nome sessione per le modifiche all'archivio.
• Choose a variable where the outcome data can be saved.

List/search sites Get a list of sites.
• Optionally, enter a Name for the list.
• Immetti il Nome sessione per le modifiche all'archivio.
• Choose a variable where the outcome data can be saved.
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Azione Descrizione

Remove a phone Remove a phone record.
• Enter the Phone ID to be removed.
• Immetti il Nome sessione per le modifiche all'archivio.

Queues palette
The Genesys command package offers a palette of actions to detail and access data for grouping records.

Queues palette for Genesys

Queues are the waiting lines of interactions. Agents select the On Queue status to enter their predefined
queues. Contact center queue settings include creating and managing queues for voice and chat channels
for the entire organization. The Genesys package includes the following queues actions:

Azione Descrizione

Add to queue Add selection to queue.
• Immetti il Nome sessione per le modifiche all'archivio.
• Enter the Queue ID of the queue that you want to add.
• Select how the data will be entered to begin adding user data to

the queue.
• If using a List:

• Select the data Type.
• Enter the Value of the data in the list.

• If using Variable, then select the established variable of the
data to be entered in the queue.

List members List the members of a queue.
• Immetti il Nome sessione per le modifiche all'archivio.
• Enter the Queue ID of the queue that you want to add.
• Choose a variable where the outcome data can be saved.

List/search queues Retrieve a list of queues that match your input criteria.
• Optionally, enter a Name for the list.
• Immetti il Nome sessione per le modifiche all'archivio.
• Choose a variable where the outcome data can be saved.
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Azione Descrizione

Remove from queue Remove selected users from a queue.
• Immetti il Nome sessione per le modifiche all'archivio.
• Enter the Queue ID for the queue that you want to remove

users from.
• Select how the data will be entered to begin adding user data to

the queue.
• If using a List:

• Select the data Type.
• Enter the Value of the data in the list.

• If using Variable, then select the established variable of the
data to be entered in the queue.

Role palette
The Genesys package offers a palette of actions to detail and access data for the roles of users.

Role palette for Genesys

Because permissions are based on the assigned role, the role of users is important in the on-boarding
process. Tasks are then assigned based on the permissions that a user has. The Genesys package includes
the following role actions:

Azione Descrizione

Add users to role Add a list of users to a role.
• Enter the Role ID of the role that you want to add users to.
• Select how the data will be entered to begin adding user data to

the role.
• If using a List:

• Select the data Type.
• Enter the Value of the data in the list.

• If using Variable, then select the established variable of the
data to be added to the role.

• Immetti il Nome sessione per le modifiche all'archivio.

List/search roles Retrieve a list of roles for the organization.
• Optionally, enter the Role name for the list.
• Immetti il Nome sessione per le modifiche all'archivio.
• Choose a variable where the outcome data can be saved.
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Azione Descrizione

List user's roles Retrieve a list of roles and permissions for a user.
• Enter the unique ID of the user for the Internal user ID.
• Immetti il Nome sessione per le modifiche all'archivio.
• Select how the outcome data will be saved.

• If using Multiple variables, use the following steps for
each variable:
• Click Add variable mapping.
• Enter the Key of the variable.
• Choose a variable where the data will be saved.
• Click Add for this list to be saved to the configured

variable.

• If using a Dictionary variable, then select the established
variable where the outcome data can be saved.

List users in a role Retrieve a list of the unique user IDs of the users in the specified
role.
• Enter the Role ID for the list.
• Immetti il Nome sessione per le modifiche all'archivio.
• Choose a variable where the outcome data can be saved.

Remove users from role Remove a list of users from a specific role.
• Enter the Role ID that you want to remove users from.
• Select how the data will be entered to begin adding user data

that will be removed from the role.
• If using a List:

• Select the data Type.
• Enter the Value of the data in the list.

• If using Variable, then select the established variable of the
data to be removed from the role.

• Immetti il Nome sessione per le modifiche all'archivio.
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Azione Descrizione

Set the user's roles Set the roles for a specific user.
• Enter the unique ID of the user for the Internal user ID.
• Select how the data will be entered to begin adding role data

that will be attributed to the user.
• If using a List:

• Select the data Type.
• Enter the Value of the data in the list.

• If using Variable, then select the established variable of the
data to be attributed to the user.

• Immetti il Nome sessione per le modifiche all'archivio.

Skill palette
The Genesys package offers a palette of actions to detail and access the skills of agents.

Skill palette for Genesys

Genesys allows for defining Automatic Call Distribution (ACD) and profile-based skills for agents. An ACD
skill routes each contact to the available agents who can best meet the contact's needs. Profile skill data
becomes keywords for advanced searches and parameters for creating groups and can also be used by
the Workforce Management capabilities to create schedule scenarios. The Genesys package includes the
following skill actions:

Azione Descrizione

Add user routing skills Attribute routing skills to a user.
• Enter a unique user ID for the Internal user ID.
• Enter the Skill ID that is to be added to the user.
• Enter the user's skill Proficiency with a value of 0-5. Zero is

low proficiency.
• Immetti il Nome sessione per le modifiche all'archivio.
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Azione Descrizione

Bulk-add routing skills Add multiple routing skills to a single user.
• Select how the skill dataset will be entered.

• If using a Table:
• Click Edit table to create your table.
• Enter the data in the cells for your table.

• If using Variable, then select the established variable of the
data to be added to the user.

• Select the proper data of the first, second, and third columns
to map the corresponding User ID, Skill ID, and Skill
proficiency of your dataset.

• Immetti il Nome sessione per le modifiche all'archivio.
• Optionally, Choose a variable where the outcome data will be

saved.

Bulk-replace routing skills Replace multiple routing skills for a single user.
• Select how the skill dataset will be entered.

• If using a Table:
• Click Edit table to create your table.
• Enter the data in the cells for your table.

• If using Variable, then select the established variable of the
data to be replaced.

• Select the proper data of the first, second, and third columns
to map the corresponding User ID, Skill ID, and Skill
proficiency of your dataset.

• Immetti il Nome sessione per le modifiche all'archivio.
• Optionally, Choose a variable where the outcome data will be

saved.

List/search routing skills Retrieve a list of routing skills.
• Optionally, enter a Skill name for the list.
• Immetti il Nome sessione per le modifiche all'archivio.
• Choose a variable where the outcome data will be saved.

List user's routing skills Retrieve a list of user's routing skills.
• Enter a unique user ID for the Internal user ID.
• Immetti il Nome sessione per le modifiche all'archivio.
• Choose a variable where the outcome data will be saved.
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Azione Descrizione

Remove user routing skills Remove routing skills for a user.
• Enter a unique user ID for the Internal user ID.
• Enter the Skill ID that you want to remove.
• Immetti il Nome sessione per le modifiche all'archivio.

User palette
The Genesys package offers a palette of actions to detail and access user records.

User palette for Genesys

A person is on-boarded as a user. User records can then be assigned with different attributes and roles.
The user record begins the process of building out a fully organized work force. The Genesys package
includes the following user actions:

Azione Descrizione

Crea utente Create a new user.
• Enter the user's Email (login ID).
• Select how you would like your password entered.

• Use Credential to pick a preconfigured credential locker.
• Use Variable to select an established credential variable.
• Use Insecure string to enter your credential in the field.

• Enter the Password required for the user to sign in.
• Enter the Full name of the user.
• Enter a Division ID for the user.
• Select whether the user State is active or inactive in the

repository.
• Optionally, enter the user's Title and Department.
• Immetti il Nome sessione per le modifiche all'archivio.

Elimina utente Delete an existing user.
• Enter the unique user ID for the Internal user ID that you

want to delete.
• Immetti il Nome sessione per le modifiche all'archivio.
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Azione Descrizione

Get user Retrieve the details of a user.
• Enter a unique user ID for Internal user ID.
• Immetti il Nome sessione per le modifiche all'archivio.
• Select how the outcome data will be saved.

• If using Multiple variables, use the following steps for
each variable:
• Click Add variable mapping.
• Enter the Key of the variable.
• Choose a variable where the data will be saved.
• Click Add for this data to be saved to the configured

variable.

• If using a Dictionary variable, then select the established
variable where outcome data can be saved.

List/search users Retrieve a list of users that match your input criteria.
• Select how the data will be entered to begin adding user data to

the search.
• If using a List:

• Select the data Type.
• Enter the Value of the data in the list.

• If using Variable, then select the established variable of the
data to be added to the list.

• Optionally, select whether the State of the user is active or
inactive.

• Immetti il Nome sessione per le modifiche all'archivio.
• Choose a variable where the outcome data can be saved.

Update user Update the details of a user. Leave any field blank if no update is
needed.
• Enter a unique user ID for the Internal user ID.
• Enter the data that you want to update, such as the following:

• Email (login ID)
• Department
• Manager
• Date hired
• Employee type
• Biography, Interests, or Hobbies
• Spouse

• Select to turn Auto answer on or off for connecting calls to the
user.

• Immetti il Nome sessione per le modifiche all'archivio.
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Google Calendar package
The Google Calendar package contains actions that enable you to automate creating and deleting
events.

Prima di iniziare

Use the actions in the Google Calendar package in the following order:
1. Utilizza l' Connetti per stabilire una connessione con il server Google.

Consulta Utilizzo dell'azione Connetti per i pacchetti Google alla pagina 1600.
2. Utilizza una combinazione di  disponibili in questo  per automatizzare le attività.

Nota:  Per utilizzare  da altri  Google, stabilisci una connessione utilizzando l' Connetti da tale .

3. Utilizza l' Disconnetti per terminare la connessione.

Actions in the Google Calendar package

The Google Calendar package includes the following actions:

Action Descrizione

Crea evento Consulta Using the Create event action in Google
Calendar alla pagina 1599.

Connetti Consulta Utilizzo dell'azione Connetti per i pacchetti
Google alla pagina 1600.

Disconnetti Consulta Disconnect action for Google packages alla
pagina 1601.

Elimina evento Consulta Delete event action in Google Calendar
alla pagina 1602.

Using the Create event action in Google Calendar
Use the Create event action to create an event and specify event attendees, duration, location,
recurrence, and title. During run time, this action triggers an email notification to meeting attendees.
To create a new calendar event, do the following:
1. Enter the session name you used to connect to the G-Suite server in the Connect action.

Consulta Utilizzo dell'azione Connetti per i pacchetti Google alla pagina 1600.
2. Enter the event title.
3. Opzionale: Enter the location.
4. Opzionale: Enter the attendees' email addresses, separated with commas.
5. Enter the start date.

Use the format yyyy-MM-dd.
6. Enter the end date.

Use the format yyyy-MM-dd.
7. Select the All Day or Specify Time option from the Event Time option.
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• If you select the All Day option, you do not need to provide any additional details.
• If you select the Specify Time option, complete the following fields:

• Specify the Start Time using the HH:mm:ss format.
• Specify the End Time using the HH:mm:ss format.

8. Select the Use System Timezone or Specify Timezone option from the Timezone option.
• If you select the Use System Timezone option, you do not need to provide any additional

details.
• If you select the Specify Timezone option, complete the following fields:

• Specify the Start Timezone.
• Specify the End Timezone.

9. Opzionale: Mark the Recurring option to make this event repeat.
10. Select a Visibility option from the drop-down list.

Select from Default, Public, or Private.
11. Opzionale: Enter an event description.
12. Opzionale: Select a string variable from the drop-down list to store the id of the created event.
13. Fai clic su Salva.

Utilizzo dell'azione Connetti per i pacchetti Google
Utilizza l'action Connetti per stabilire una connessione con il server Google al fine di utilizzare altre actions
dello stesso package per automatizzare le attività. Tutti i campi in questa action accettano una credenziale
da Credential Vault, una variabile o un valore immesso dall'utente.
Configura le impostazioni OAuth in Google Cloud Platform e recupera le credenziali necessarie per
connettere Automation Anywhere Enterprise alle applicazioni Google G Suite.
1. Se non lo hai già fatto, crea un progetto.
2. Abilita le API per le applicazioni Google G Suite che si desidera automatizzare, come le API Google

Drive, le API Google Calendar e le API Google Sheets.
3. Esegui la procedura descritta in Configurazione di OAuth 2.0 per generare l'ID client e Segreto.

Nota:
• Seleziona l'opzione Applicazione Web.
• Add this authorized redirect URI: http://localhost:8888/Callback

4. Do these steps to set up user consent for the username that you will use to connect to the Automation
Anywhere Enterprise.

1. Nella tavolozza Actions, fai doppio clic o trascina l'action Connetti dal package che desideri
utilizzare.

2. In the Username field, you can provide a valid username or select the credential or credential
variable that contains your Google username. Per immettere un valore, fai clic sulla Stringa non
sicura.

3. Se stai configurando l'action Connetti per Google Calendar o Google Sheets package, immetti un
nome di sessione.

© 2023 Automation Anywhere. All rights reserved.     1600

https://cloud.google.com/resource-manager/docs/creating-managing-projects#gcloud
https://developers.google.com/identity/protocols/oauth2/web-server#enable-apis
https://support.google.com/googleapi/answer/6158849?hl=en&ref_topic=7013279
https://support.google.com/googleapi/answer/6158849?hl=en&ref_topic=7013279#zippy=%2Cuser-consent


    Automation Anywhere - Crea

4. Nel campo ID client, seleziona la credenziale o la variabile credenziale che contiene l'ID client. Per
immettere un valore, fai clic sulla Stringa non sicura.

5. In the Redirect URI field, enter http://localhost:8888/Callback

Nota:  For the Google Sheets package, the Redirect URI attribute is not supported. Enter the fixed
redirect URL directly in Google Cloud Platform: http://localhost:8888/Callback

6. Nel campo Client segreto, seleziona la credenziale o la variabile credenziale che contiene il token di
accesso. Per immettere un valore, fai clic sulla Stringa non sicura.

7. For Google Sheets, you can specify the wait time (in minutes) in the Wait for action to complete
(In minutes) field when performing actions such as Get, Set, or Delete. By default, the wait time is
10 minutes.
Se il foglio di Google non si apre entro l'intervallo di tempo specificato, l'attività passa all'esecuzione
della serie di actions successive.

Nota:  When you use Connect action to connect to the Google server, the option Wait for action to
complete (In minutes) is only supported in Google Sheets package.

8. Fai clic su Salva.
9. After you add actions from a specific Google package, use the Disconnect action from that same

Google package to terminate the connection.

The first time the bot runs, the Google login window is displayed. È necessario selezionare l'account Google
e approvare le autorizzazioni di accesso richieste.
The token file gets generated for the first time after you provide the access permissions when the bot gets
deployed. It is created based on values that you provide in the Username, Client Id and Client secret
field, and asks for credentials only the first time to provide the access permission. Next time it uses the
same token file to connect to the Google Sheets.
The token file is located at C:\Users\&lt;username&gt;\AppData\Local\AutomationAnywhere
\G-SuitAuth, where C:\Users\&lt;username&gt; is the user home directory of the respective
system.
If you enter the correct credentials when providing access permissions for the first time and can connect
to the Google Sheets successfully, then next time if there is a change in only the password, you need not
delete the token file as it will work as expected.
Utilizza le altre actions dello stesso package Google per automatizzare le attività. Per utilizzare actions da
altri pacchetti packages Google, stabilisci una connessione utilizzando l'action Connetti da tale package.
Riferimenti correlati
Google Calendar package alla pagina 1599
The Google Calendar package contains actions that enable you to automate creating and deleting
events.
Pacchetto Google Drive alla pagina 1602
Automatizza attività relative a file e cartelle utilizzando le actions contenute nel package Google Drive.
Google Sheets package alla pagina 1612
Il package Fogli Google contiene actions che consentono di automatizzare le attività che coinvolgono
celle, colonne, righe e fogli.

Disconnect action for Google packages
Use the Disconnect action from a specific Google package to terminate the connection after you have
added actions from the same Google package.
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Impostazioni

• In the Username field, you can provide a valid username or select the credential or credential variable
that contains your Google username. Per immettere un valore, fai clic sulla Stringa non sicura.

• For Google Calendar and Google Sheets packages, enter the session name that you used in the
Connect action.

• Select the check box Logout from the browser if you want to sign off from your account.

Delete event action in Google Calendar
You can remove an event from the calendar using the Delete event action.

Impostazioni

Removes the event from the calendar.
• Enter the same session name that you provided in the Connect .
• Enter the Event Id. This is the string in the URL that appears after /eventedit/ when you open an

event for editing.
• Facoltativo: Assign the event to a String variable.

Pacchetto Google Drive
Automatizza attività relative a file e cartelle utilizzando le actions contenute nel package Google Drive.

Prima di iniziare

Usa le actions nel package Google Drive nel seguente ordine:
1. Utilizza l' Connetti per stabilire una connessione con il server Google.

Consulta Utilizzo dell'azione Connetti per i pacchetti Google alla pagina 1600.
2. Utilizza una combinazione di  disponibili in questo  per automatizzare le attività.

Nota:  Per utilizzare  da altri  Google, stabilisci una connessione utilizzando l' Connetti da tale .

3. Utilizza l' Disconnetti per terminare la connessione.
Consulta Disconnect action for Google packages alla pagina 1601.

Actions nel package Google Drive

Il package Google Drive comprende le seguenti actions:

Action Descrizione

Verifica autorizzazioni Consulta Check permissions action in Google Drive
alla pagina 1604.

Copia file Consulta Copy file action in Google Drive alla
pagina 1605.
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Action Descrizione

Copia cartella Consulta Copy folder action in Google Drive alla
pagina 1605.

Create file permission Consulta Create file permission action in Google
Drive alla pagina 1605.

Create folder Consulta Create folder action in Google Drive alla
pagina 1606.

Elimina file Consulta Delete file action in Google Drive alla
pagina 1606.

Delete file permission Consulta Delete file permission action in Google
Drive alla pagina 1607.

Elimina cartella Consulta Delete folder action in Google Drive alla
pagina 1607.

Scarica file Consulta Download file action in Google Drive alla
pagina 1607.

Trova file/cartella Consulta Find file/folder action in Google Drive alla
pagina 1608.

Get file information Consulta Get file information action in Google Drive
alla pagina 1608.

Get file permission Consulta Get file permission action in Google Drive
alla pagina 1608.

Sposta file Consulta Move file action in Google Drive alla
pagina 1608.

Sposta cartella Consulta Move folder action in Google Drive alla
pagina 1609.

Apri file Apre un file dalla directory specificata su Google
Drive.
• Immetti lo stesso nome utente fornito nell'

Connetti.
• Scegli se identificare il file in base al percorso

e al nome del file o in base all'ID.

Nota:  L'ID è il valore nell'URL dopo l'ultima
barra. For example, if the URL is https://
docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.
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Action Descrizione

Apri cartella Apre una cartella dalla directory specificata su
Google Drive.
• Immetti lo stesso nome utente fornito nell'

Connetti.
• Select whether to identify the folder by

directory path and name, or by ID.

Nota:  L'ID è il valore nell'URL dopo l'ultima
barra. For example, if the URL is https://
docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

Rinomina file Consulta Rename file action in Google Drive alla
pagina 1609.

Rinomina cartella Consulta Rename folder action in Google Drive alla
pagina 1609.

Carica file Consulta Upload file action in Google Drive alla
pagina 1610.

Update file permission Aggiorna le autorizzazioni per un file.
• Scegli se identificare il file in base al percorso

e al nome del file o in base all'ID.

Nota:  L'ID è il valore nell'URL dopo l'ultima
barra. For example, if the URL is https://
docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

• Nel campo ID autorizzazione, immetti l'ID
utente.

• Seleziona un ruolo. Per ulteriori informazioni,
consulta Ruoli di Google Drive.

• Facoltativo: seleziona o crea una variabile
per conservare l'ID autorizzazione.

Check permissions action in Google Drive
The Check permissions action enables you to check permissions for a file or folder on Google Drive and
returns read, write, or delete to a list variable.

Impostazioni

Checks for a file or folder permissions and returns read, write, or delete to a list variable.
• Immetti lo stesso nome utente fornito nell' Connetti.
• Seleziona se controllare le autorizzazioni per un file o una cartella. Seleziona File o Cartella e inserisci

il nome e il percorso del file o della cartella. To check the permissions of files shared with you in Google
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Drive, select File ID to enter the file id. You can extract the file id from the URL of the file name and
enter it in the File ID field.

Nota:  Selezionando l'opzione ID file, l'utente con un ruolo Commentatore con accesso in scrittura
osserverà che il bot non controlla l'autorizzazione per la scrittura e restituisce il valore come falso.

• Per controllare i vari tipi di autorizzazioni, selezionare Lettura, Scrittura o Eliminazione. Questo
restituisce lettura, scrittura o eliminazione in una variabile booleana.

• Seleziona o crea una variabile booleana per conservare le autorizzazioni.

Copy file action in Google Drive
The Copy file action enables you to copy a file from one folder to another on Google Drive.

Impostazioni

• Immetti lo stesso nome utente fornito nell' Connetti.
• Select whether to identify the source file by file path and name, or by ID.

Nota:  L'ID è il valore nell'URL dopo l'ultima barra. For example, if the URL is https://
docs.google.com/spreadsheets/d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

• Scegli se identificare la cartella di destinazione in base al percorso e al nome della directory o in base
all'ID.

• Facoltativo: seleziona l'opzione Rinomina file e immetti il nuovo nome del file.

Copy folder action in Google Drive
Use Copy folder action to copy a folder from one location to another.

Impostazioni

Copia una cartella da una posizione a un'altra.
• Immetti lo stesso nome utente fornito nell' Connetti.
• Scegli se identificare il file sorgente in base al percorso e al nome della cartella o in base all'ID. If this is

a shared folder, you must use the Folder ID option.

Nota:  L'ID è il valore nell'URL dopo l'ultima barra. For example, if the URL is https://
docs.google.com/spreadsheets/d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

• Scegli se identificare la cartella di destinazione in base al percorso e al nome della directory o in base
all'ID.

Create file permission action in Google Drive
You can create a new permission for a file by using the Create file permission action.
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Impostazioni

Crea una nuova autorizzazione per un file.
• Immetti lo stesso nome utente fornito nell' Connetti.
• Select whether to identify the file by file path and name, or by ID.

Nota:  L'ID è il valore nell'URL dopo l'ultima barra. For example, if the URL is https://
docs.google.com/spreadsheets/d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

• Seleziona un ruolo. Per ulteriori informazioni, consulta Ruoli di Google Drive.
• Seleziona il tipo di assegnatario. Scegli tra:

• Utente
• Gruppo
• Dominio
• Chiunque

• Se selezioni Utente o Gruppo, inserisci l'indirizzo e-mail. Se selezioni il dominio, inserisci il dominio.
• Facoltativo: seleziona o crea una variabile per conservare l'ID autorizzazione.

Create folder action in Google Drive
This action enables you to create a folder in Google drive.

Impostazioni

Crea una cartella.
• Immetti lo stesso nome utente fornito nell' Connetti.
• Immetti la cartella principale dove creare la cartella. To create the folder in the root folder enter root.
• Immetti il nome della cartella.
• Facoltativo: seleziona o crea una variabile stringa per conservare l'ID della nuova cartella.

Nota:  You cannot create a folder in the Shared with me folder because Google API does not support it.

Delete file action in Google Drive
Use the Delete file action to delete a file on your Google Drive.

Impostazioni

• Immetti lo stesso nome utente fornito nell' Connetti.
• Select whether to identify the file by file path and name, or by ID.

Nota:  L'ID è il valore nell'URL dopo l'ultima barra. For example, if the URL is https://
docs.google.com/spreadsheets/d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

• Facoltativo: seleziona o crea una variabile booleana per conservare lo stato di eliminazione del file.
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Delete file permission action in Google Drive
You can delete a file permission for a file by using the Delete file permission action.

Impostazioni

• Immetti lo stesso nome utente fornito nell' Connetti.
• Select whether to identify the file by file path and name, or by ID.

Nota:  L'ID è il valore nell'URL dopo l'ultima barra. For example, if the URL is https://
docs.google.com/spreadsheets/d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

• Nel campo ID autorizzazione, immetti l'ID autorizzazione.
• Facoltativo: seleziona o crea una variabile per conservare l'ID autorizzazione.

Delete folder action in Google Drive
Delete folder action enables you to delete a folder from the Google Drive.

Impostazioni

• Immetti lo stesso nome utente fornito nell' Connetti.
• Scegli se identificare la cartella in base al percorso e al nome o in base all'ID.

Nota:  L'ID è il valore nell'URL dopo l'ultima barra. For example, if the URL is https://
drive.google.com/drive/folders/0B0MqCb--3Y8QQzlJcVRJb3UxcTg, the ID is
0B0MqCb--3Y8QQzlJcVRJb3UxcTg.

• Facoltativo: seleziona o crea una variabile booleana per conservare lo stato di eliminazione della
cartella.

Download file action in Google Drive
You can download a file from your Google Drive to a specific location on your desktop.

Impostazioni

• Immetti lo stesso nome utente fornito nell' Connetti.
• Select whether to identify the file by file path and name, or by ID.

Nota:  L'ID è il valore nell'URL dopo l'ultima barra. For example, if the URL is https://
docs.google.com/spreadsheets/d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

• Specifica il percorso del file da scaricare. Ad esempio, C:/Users/Downloads.
• Facoltativo: seleziona l'opzione Sovrascrivi file esistente per sovrascrivere il file con lo stesso

nome.
• Facoltativo: seleziona l'opzione Rinomina file per immettere un nuovo nome per il file scaricato.
• Facoltativo: seleziona o crea una variabile per contenere l'ID del file scaricato.
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Find file/folder action in Google Drive
The Find file/folder action enables you to find files or folders in a specific directory in your Google Drive.

Impostazioni

• Immetti lo stesso nome utente fornito nell' Connetti.
• Seleziona se cercare file o cartelle.
• Immetti la cartella di origine in cui cercare. Ad esempio /Home/Accounts/.
• Specifica se restituire corrispondenze esatte o
• Immetti il nome del file o della cartella da cercare.
• Seleziona o crea una variabile per contenere l'elenco di file o cartelle.

Get file information action in Google Drive
Use the Get file information action in the Google Drive package to enable you to get the file information
of a file from Google Drive.

Impostazioni

• Immetti lo stesso nome utente fornito nell' Connetti.
• Scegli se identificare il file in base al percorso e al nome del file o in base all'ID. If this is a shared

folder, you must use the FILE ID option.

Nota:  L'ID è il valore nell'URL dopo l'ultima barra. For example, if the URL is https://
docs.google.com/spreadsheets/d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9

• Select or create a dictionary variable to hold the file information which is stored in two keys: the name
key holds the file name and the extension key holds the file extension.

Get file permission action in Google Drive
Use the Get file permission action in the Google Drive package to enable you to retrieve file permission
of a file or a folder from Google Drive.

Impostazioni

• Immetti lo stesso nome utente fornito nell' Connetti.
• Select whether to identify the file by file path and name, or by ID.

Nota:  L'ID è il valore nell'URL dopo l'ultima barra. For example, if the URL is https://
docs.google.com/spreadsheets/d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

• Seleziona o crea una variabile elenco per conservare le autorizzazioni ai file.

Move file action in Google Drive
Use the Move file action in the Google Drive package to enable you to move file from one folder to
another on Google Drive.
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Impostazioni

• Immetti lo stesso nome utente fornito nell' Connetti.
• Select whether to identify the file by file path and name, or by ID.

Nota:  L'ID è il valore nell'URL dopo l'ultima barra. For example, if the URL is https://
docs.google.com/spreadsheets/d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

• Select whether to identify the destination folder by directory path and name, or by ID.

Nota:  L'ID è il valore nell'URL dopo l'ultima barra. For example, if the URL is https://
docs.google.com/spreadsheets/d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

Move folder action in Google Drive
Use the Move folder action in the Google Drive package to enable you to move a folder from one location
to another on Google Drive.

Impostazioni

• Immetti lo stesso nome utente fornito nell' Connetti.
• Scegli se identificare il file sorgente in base al percorso e al nome della cartella o in base all'ID. If this is

a shared folder, you must use the Folder ID option.

Nota:  L'ID è il valore nell'URL dopo l'ultima barra. For example, if the URL is https://
docs.google.com/spreadsheets/d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

• Scegli se identificare la cartella di destinazione in base al percorso e al nome della directory o in base
all'ID.

Rename file action in Google Drive
Use the Rename file action in the Google Drive package to enable you to rename a file on Google Drive.

Impostazioni

• Immetti lo stesso nome utente fornito nell' Connetti.
• Select whether to identify the file by file path and name, or by ID.

Nota:  L'ID è il valore nell'URL dopo l'ultima barra. For example, if the URL is https://
docs.google.com/spreadsheets/d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

• Immetti il nuovo nome del file.

Rename folder action in Google Drive
Use the Rename folder action in the Google Drive package to enable you to rename a folder in a specific
directory on Google Drive.
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Impostazioni

• Immetti lo stesso nome utente fornito nell' Connetti.
• Select whether to identify the folder by directory path and name, or by ID.

Nota:  L'ID è il valore nell'URL dopo l'ultima barra. For example, if the URL is https://
docs.google.com/spreadsheets/d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

• Immetti il nuovo nome della cartella.

Upload file action in Google Drive
Use the Upload file action in the Google Drive package to enable you to upload a file from your computer
to Google Drive.

Impostazioni

• Immetti lo stesso nome utente fornito nell' Connetti.
• Immetti il percorso e il nome del file.
• Select whether to identify the folder where to upload the file by directory path and name, or by ID.

Nota:  L'ID è il valore nell'URL dopo l'ultima barra. For example, if the URL is https://
docs.google.com/spreadsheets/d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

• Facoltativo: seleziona l'opzione Sovrascrivi file esistente per sovrascrivere il file con lo stesso
nome.

• Facoltativo: seleziona o crea una variabile per conservare l'ID del file caricato.

Google Document AI package
Extract data from documents by using the Google Document AI capabilities of the Google Document AI
package in your bots.

Prima di iniziare

Create a processor in Google Document AI. Crea un processore.
Usa le actions nel package Google Drive nel seguente ordine:
1. Usa l'action Connetti per stabilire una connessione con il tuo account del servizio Google Cloud.
2. Configura l'action Estrai per specificare la posizione dei documenti da estrarre e fornire i dettagli del

processore.
3. Utilizza l'action Disconnetti per terminare la connessione.

Actions nel package Google Document AI

Il package Google Document AI include le seguenti actions:

© 2023 Automation Anywhere. All rights reserved.     1610

https://cloud.google.com/document-ai/docs/create-processor


    Automation Anywhere - Crea

Action Descrizione

Connetti Stabilisce una connessione con l'account del servizio Google
Cloud.
Fornisci quanto segue:
• Percorso file chiave: seleziona il file JSON che contiene la

chiave del tuo account del servizio Google Cloud.
• Sessione del servizio Google Cloud: inserisci un nome

univoco per la sessione.

Estrai Sends documents to Google Document AI for data extraction.
Using the Extract action for Google Document AI alla pagina 1611

Disconnetti Disconnette dall'account del servizio Google.
Nel campo Nome sessione, inserisci il nome della sessione
utilizzata per connetterti all'account del servizio Google nell'action
Connetti.

Using the Extract action for Google Document AI
Configure the Extract action to enable your bot to send documents to Google Document AI for data
extraction and retrieve the output in JSON format.
Login to your Google Cloud account and go to the Processors page to retrieve your custom endpoint. See
Use your processor endpoint.
Your custom endpoint should follow this format: https://LOCATION-documentai.googleapis.com/
API_VERSION/projects/PROJECT_ID/locations/LOCATION/processors/PROCESSOR_ID. You
will need the parameters in bold to configure this action.
1. Double-click or drag the Google Document AI > Extract action.
2. In the Document file path field, provide the file path to the document you want to process.

Nota:  If using this action within a Loop action to process all the documents in a folder, be sure to
include a period between the variable holding the file name and the one holding the extension. For
example, C:\Documents\$dictFile(name)$.$dictFile(extension)$.

3. Provide the following information, which is found in your custom endpoint.
• Project id
• Processor id
• Luogo

4. In the Session name field, enter the name of the session you used to connect to the Google service
account in the Connect action.

5. Opzionale: Seleziona o crea una variabile stringa per mantenere l'output.
The action returns data in JSON format.

6. Fai clic su Salva.

You can use the actions in the JSON package to parse the data and extract values from specific nodes. For
an overview of how to do this, refer to the following steps:
1. Initiate the JSON session with the Start session action. In the JSON text field, insert the string

variable holding the output of the Extract action.
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2. Use the Get node value action to parse the output of the Google Document AI > Extract action
and assign the node values to a list variable.
You can insert a Loop action after the Get node value action to iterate through each list item to
perform an operation on each node value.

3. Terminate the JSON session with the End session action.

Google Sheets package
Il package Fogli Google contiene actions che consentono di automatizzare le attività che coinvolgono
celle, colonne, righe e fogli.

Prima di iniziare

Usa le actions nel package Fogli Google nel seguente ordine:
1. Utilizza l' Connetti per stabilire una connessione con il server Google.

Consulta Utilizzo dell'azione Connetti per i pacchetti Google alla pagina 1600.
2. Utilizza una combinazione di  disponibili in questo  per automatizzare le attività.

Nota:  Per utilizzare  da altri  Google, stabilisci una connessione utilizzando l' Connetti da tale .

3. Utilizza l' Disconnetti per terminare la connessione.

Actions nel package Fogli Google

Le actions contenute nel package Fogli Google consentono di effettuare le seguenti operazioni:

Action Descrizione

Attiva foglio Consulta Activate sheet action in Google Sheets alla
pagina 1614.

Adatta colonne automaticamente Consulta Autofit columns action in Google Sheets
alla pagina 1614.

Adatta righe Consulta Autofit rows action in Google Sheets alla
pagina 1614.

Chiudi Consulta Close action in Google Sheets alla pagina
1614.

Crea foglio Consulta Create sheet action in Google Sheets alla
pagina 1614.

Crea cartella di lavoro Consulta Create workbook action in Google Sheets
alla pagina 1615.

Elimina cella Consulta Delete cell action in Google Sheets alla
pagina 1615.

Elimina intervallo Consulta Delete range action in Google Sheets alla
pagina 1615.
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Action Descrizione

Elimina riga o colonna Consulta Delete row/column action in Google Sheets
alla pagina 1616.

Elimina foglio Consulta Delete sheet action in Google Sheets alla
pagina 1616.

Disconnetti Consulta action Disconnetti alla pagina 1616.

Formato celle Consulta Format cells action alla pagina 1617.

Ottieni nomi di tutti i fogli Consulta Get All Sheet Names action alla pagina
1617.

Get Cell/text color See Get Cell/text color action.

Ottieni nome foglio di lavoro corrente See Get Current Sheet Name action.

Ottieni più celle Consulta Get multiple cells action in Google Sheets
alla pagina 1618.

Ottieni numero di righe Consulta Get number of rows action alla pagina
1618.

Ottieni cella singola Consulta Get single cell action in Google Sheets alla
pagina 1618.

Vai alla cella Consulta Go to cell action in Google Sheets alla
pagina 1619.

Nascondi foglio di lavoro Consulta Hide worksheet action alla pagina 1619.

Inserisci cella Consulta Insert cell action alla pagina 1619.

Inserisci intervallo See Insert range action.

Inserisci riga o colonna Consulta Insert row/column action in Google Sheets
alla pagina 1620.

Apri foglio di calcolo Consulta Open spreadsheet action in Google Sheets
alla pagina 1620.

Incolla cella Vedi Paste cell action alla pagina 1620

Leggi formula della cella Vedi Read cell formula action alla pagina 1621

Leggi colonna Consulta Read column action in Google Sheets alla
pagina 1621.

Leggi riga Consulta Read row action in Google Sheets alla
pagina 1621.

Rinomina foglio Consulta Rename sheet action alla pagina 1622.

Retrieve Sheets count See Retrieve Sheets count action.

Imposta cella Consulta Set cell action in Google Sheets alla
pagina 1622.

Imposta formula cella Vedi Set cell formula action alla pagina 1622

Set cell or text color Vedi Set cell or text color action alla pagina 1623

Mostra foglio di lavoro Vedi Show worksheet action alla pagina 1623
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Action Descrizione

Scrivi da tabella dati Consulta Write from data table action in Google
Sheets alla pagina 1623.

Activate sheet action in Google Sheets
Activate sheet action enables you to activate a specific sheet in the open spreadsheet.

Impostazioni

Consente di attivare un foglio specifico in Apri foglio di calcolo.
• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l'action Apri foglio

di calcolo.
• Specifica se attivare il foglio per indice o per nome.

Nota:  Il conteggio dell'indice dei fogli inizia da 1.

Autofit columns action in Google Sheets
Autofit columns action enables you to resize the columns that contain data to accommodate the data.

Impostazioni

Ridimensiona le colonne che contengono dati per organizzare i dati. Inserisci il nome della sessione
utilizzata per aprire il foglio di calcolo corrente con l'action Apri foglio di calcolo.

Autofit rows action in Google Sheets
Autofit rows action enables you to resize the rows that contain data to accommodate the data.

Impostazioni

Ridimensiona le righe che contengono dati per organizzare i dati. Inserisci il nome della sessione utilizzata
per aprire il foglio di calcolo corrente con l'action Apri foglio di calcolo.

Close action in Google Sheets
With Close action, you can save and close the current spreadsheet.

Impostazioni

Salva e chiude il foglio di calcolo corrente. Inserisci il nome della sessione utilizzata per aprire il foglio di
calcolo corrente con l'action Apri foglio di calcolo.

Create sheet action in Google Sheets
Create sheet action enables you to create a new sheet in the open workbook.
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Impostazioni

Crea un nuovo foglio nella cartella di lavoro aperta.

• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l' Apri foglio di
calcolo.

• Specifica se creare il foglio per indice o per nome.

Nota:  Il conteggio dell'indice dei fogli inizia da 1.

Create workbook action in Google Sheets
Create workbook action enables you to create a new workbook in your Google Sheets.

Impostazioni

Creates a new Google Sheets workbook.
• Inserisci il nome utente che hai usato nella finestra dell'action Connect.
• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l' Apri foglio di

calcolo.
• Inserisci il nome della cartella di lavoro con una delle seguenti estensioni di file: .xlsx, .xls o .xlsm
• Inserisci il percorso del file per la nuova cartella di lavoro o seleziona una variabile file.

Delete cell action in Google Sheets
Delete cell action enables you to delete cells within a worksheet.

Impostazioni

Elimina celle all'interno di un foglio di calcolo.
• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l' Apri foglio di

calcolo.
• Seleziona l'opzione Cella attiva o Cella specifica. Se è stata selezionata Cella specifica, immetti

l'indirizzo della cella.
• Scegli tra le seguenti opzioni per eliminare:

• Sposta celle a sinistra
• Sposta celle in basso
• Intera riga
• Intera colonna

Delete range action in Google Sheets
Delete range action enables you to delete a range of cells.
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Impostazioni

Deletes a range of cells.
• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l' Apri foglio di

calcolo.
• Inserisci l'indirizzo di intervallo. For example A1:B4.
• Seleziona la direzione in cui spostare le celle attive rimanenti: Su o Sinistra.

Delete row/column action in Google Sheets
Delete row/column action enables you to delete a row or column in a worksheet.

Impostazioni

Elimina una riga o colonna in un foglio di lavoro.
• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l' Apri foglio di

calcolo.
• Seleziona se eseguire un'operazione di riga o di colonna.
• Specifica se eliminare il foglio per indice o per nome.
• Specifica se eliminare per indice, cella attiva o intervallo.

• Se selezioni indice, inserisci l'indice di riga o colonna

Nota:  Il conteggio dell'indice inizia da 1.

• Se selezioni intervallo, specifica l'intervallo delle righe o colonne da eliminare. For example 1:10 to
delete the first ten rows.

Delete sheet action in Google Sheets
Use the Delete sheet action in the Google Sheets package to delete a sheet from a workbook.

Impostazioni

• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l' Apri foglio di
calcolo.

• Specifica se eliminare il foglio per indice o per nome.

action Disconnetti
The Disconnect action terminates the connection with the Google Sheets app. Enter the session name that
you used in the Connect action. Add this action at the end of automation sequences that use actions from
this Google Sheets package.

Impostazioni

• In the Username field, you can provide a valid username or select the credential or credential variable
that contains your Google username. Per immettere un valore, fai clic sulla Stringa non sicura.

• Enter the session name that you used in the Connect action.
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• Select the check box Logout from the browser if you want to sign off from your account.

Format cells action
The Format cells action enables you to format specific cells of a workbook.

Impostazioni

• Enter the session name that you used in the Connect action.
• Use the Cell options field to select one of the following format options:

• Active cell: Is the default selection and is used to format the current or active cell from the
workbook.

• Specific cell: Use the Cell Name field to enter the name of the cell from the workbook.
• Multiple cells: Use the Cell range filed to specify the range for of all the cells from the workbook

that you want to format.

• (Optional) Select Font check box to change the font specifications of the content such as name, size
and color.

• (Optional) Select Alignment check box to change the vertical or horizontal alignment of the content.
• (Optional) Select Wrap Text check box to change the default text wrap option of the content.
• (Optional) Select Merge Type check box to choose from various merge options.

Get All Sheet Names action
The Get All Sheet Names action enables you to retrieve the names of all the sheets within a specific
workbook and store it as a variable.

Impostazioni

• Enter the session name that you used in the Connect action.
• Use the Store All Sheet Names to field for one of the following options:

• Select an existing variable from the Choose a variable drop-down menu.
• Click Create variable icon for a new variable.

Use the Create Variable screen to enter a name, variable type (input or output), and a subtype.

Get Cell/text color action
Use the Get cell/text color action to get the color of the background or text in a cell. This action
retrieves the color of a cell as RGB values. For example, if the background or text in a cell is of red color,
the value retrieved is 255,0,0.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• To get the color from the current active cell, select Active cell, or, to get the color from a specific cell,

select Specific cell.
• Specify the cell name or address in the Cell name.
• to get the background color of the cell, select Cell Color.
• To get the color of the text, or both, select Text Color.
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• Specify whether to retrieve the cell color by Name or Code.
• To assign the cell/text color to a List variable, select one of the options from the Assign the output to

variable drop-down.

Get Current Sheet Name action
The Get Current Sheet Nameaction for the Google Sheets package enables you to retrieve the name of
the current worksheet in a workbook.

Impostazioni

• Enter the session name or select an existing variable used in the Session name field.
• In the Store Current Sheet Name to field, enter the destination to store the current sheet or select it

from the variables.

Get multiple cells action in Google Sheets
Use the Get multiple cells action in the Google Sheets package to retrieve values from cells in a Google
sheet and store them in a table variable.

Impostazioni

• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l' Apri foglio di
calcolo.

• Select the Multiple cells option to retrieve values from a range of cells, or select All cells to retrieve
values from all cells.

• Seleziona o crea una variabile tabella per mantenere l'output.

Get number of rows action
The Get number of rows action in the Google Sheets package enables you to get the number of rows
that are not empty or contain data.

Impostazioni

• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l'action Apri foglio
di calcolo.

• Select the Non-empty rows option to get the number of rows that are not empty or the Total rows
with data option to get the number of rows that contain data.

• Select the number variable from the Assign output to a variable field to store the output.

Get single cell action in Google Sheets
Use the Get single cell action in the Google Sheets package to retrieve the value from a specific cell in a
Google sheet and store it in a string variable.

Impostazioni

• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l' Apri foglio di
calcolo.
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• Seleziona l'opzione Cella attiva o Cella specifica. Se è stata selezionata Cella specifica, immetti
l'indirizzo della cella.

• Seleziona o crea una variabile stringa per mantenere l'output.

Go to cell action in Google Sheets
Use the Go to cell action in the Google Sheets package to go to the specified cell.

Impostazioni

• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l' Apri foglio di
calcolo.

• Select a Cell Options. Se è stata selezionata l'opzione Cella specifica, immetti l'indirizzo della cella.
Ad esempio, B4.

Hide worksheet action
The Hide worksheet action in the Google Sheets package enables you to hide a worksheet from the current
workbook.

Impostazioni

• In the Worksheet name field, specify the name of the worksheet to hide.

Nota:  Puoi nascondere un foglio di lavoro solo se la cartella di lavoro ne contiene più di uno.

• Enter the name of the session that you used to open the workbook with the Open spreadsheet
action.

Insert cell action
The Insert cell action enables you to insert a cell at a specific point in a workbook by shifting any existing
cell.

Impostazioni

• Enter the session name that you used in the Connect action.
• Use the Cell options field to select one of the following format options:

• Active cell: Is the default selection and is used to format the current or active cell from the
workbook.

• Specific cell: Use the Cell Name field to enter the name of the cell from the workbook.

• Use the Shift type field to select how an existing cell must be shifted.

Insert range action
The Insert range action of the Google Sheets package enables you to insert the range into the current
worksheet without overwriting the existing value.
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Impostazioni

• Enter the session name or select an existing variable used in the Session name field .
• Enter the cell range in the Range address. For example A1:B4. This inserts a range of cells consisting

of the first four rows by the first two columns.
After inserting the cell, set the Shift type to Down to shift the existing values down by the specified
number of rows. Or Right to shift the existing values right by the specified number of columns.

Insert row/column action in Google Sheets
Use the Insert Row/Column action in the Google Sheets package to insert a blank row or column into a
spreadsheet.

Impostazioni

• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l' Apri foglio di
calcolo.

• Seleziona se inserire una riga o una colonna.
• If you chose Row Operations, select whether to insert the row at a specific index, above the active

cell, or in a range.

Nota:  Il conteggio dell'indice inizia da 1.

• If you chose Column Operations, select whether to insert the column at a specific address, to the
left of the active cell, or in a range.

Open spreadsheet action in Google Sheets
Use the Open spreadsheet action in the Google Sheets package to open an existing spreadsheet.

Impostazioni

• In the Username field, enter the same username that you provided in the Connect action.
• Inserisci un nome della sessione. Utilizza il nome di questa sessione nelle actions successive da

associare a questo foglio di calcolo.
• Seleziona se aprire il foglio di calcolo per nome, URL o ID foglio di calcolo:

• Nome: Inserisci il nome del file.
• URL: Immetti l'intero URL.
• ID foglio di calcolo: L'ID è il valore nell'URL dopo l'ultima barra. For example, if the URL is

https://docs.google.com/spreadsheets/d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

• Se il foglio di calcolo contiene più fogli, seleziona l'opzione Nome foglio specifico e immetti il nome
del foglio.

Paste cell action
The Paste cell action in the Google Sheets package enables you to copy a value from a cell and pastes to
a specified cell.
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Impostazioni

• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l'action Apri foglio
di calcolo.

• Select the Active cell or Specific cell option to specify the cell from which to read the format. If you
have selected the Specific cell option, enter the cell name and specify the address of the cell in the
field.

Read column action in Google Sheets
Use the Read column action in the Google Sheets package to retrieve data from a column and store it in
a list variable.

Impostazioni

• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l' Apri foglio di
calcolo.

• In the Cell options field, specify the cell location from which to read the values. Ad esempio, immetti
A5 per recuperare tutti i valori situati nella prima colonna, sotto la quinta riga.

• Puoi anche selezionare l'opzione Leggi colonna intera per estrarre i valori dall'intera colonna.
• Seleziona o crea una variabile elenco per mantenere l'output.

Read row action in Google Sheets
Use the Read row action in the Google Sheets package to retrieve data from a row and store it in a list
variable.

Impostazioni

• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l' Apri foglio di
calcolo.

• In the Cell options field, specify the cell location from which to read the values. For example, enter D5
to retrieve the values located in the fifth row and right of the fourth column.

• Puoi anche selezionare l'opzione Leggi riga intera per estrarre i valori dall'intera riga.
• Seleziona o crea una variabile elenco per mantenere l'output.

Read cell formula action
The Read cell formula action in the Google Sheets package enables you to retrieve the formula available
in the Active cell or Specific cell and assign the output to a string variable. This action returns a blank
value if the specified cell does not contain a formula.

Impostazioni

• Enter the name of the session that you used to open the workbook with the Open spreadsheet action
• Select the Active cell or Specific cell option to specify the cell from which to read the formula.

Nota:  If you have selected the Specific cell option, specify the address of the cell in the field.
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• In the Assign the output to variable field, select a string variable to store the name of the formula.
La  mostra un nome descrittivo predefinito della variabile. If you create several output variables,
subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.

Rename sheet action
The Rename sheet action enables you to rename a specific sheet of a workbook.

Impostazioni

• Enter the session name that you used in the Connect action.
• Use the Sheet field to select one of the following format options:

• Index: Use this option to select an index that must be renamed.
• Name: Use this option and enter the name of the sheet that you want to rename.

• Use the Enter new name for the sheet field to enter a name that must be added.

Retrieve sheets count action
The Retrieve sheets count action of the Google Sheets package enables you to get the number of
sheets available in the current workbook and store it in a number variable

Impostazioni

• Enter the session name or select an existing variable used in the Session name field.
• Select the Exclude Hidden Worksheets option to exclude the hidden worksheet or not and assign

the count to a variable.
• From the Assign the output to a variable listdrop-down, specify the variable to which you want to

assign the output.

Set cell action in Google Sheets
Use the Set cell action in the Google Sheets package to set the value of a specific cell.

Impostazioni

• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l' Apri foglio di
calcolo.

• Immetti l'indirizzo della cella. For example, A5.
• Seleziona o crea una variabile stringa per mantenere il valore della cella.

Set cell formula action
The Set cell formula action of the Google Sheets package enables you to set a formula in the active cell or
a specific cell in a Google sheet.

Impostazioni

• Enter the name of the session used to open the workbook with the Open spreadsheet action.
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• Select the Active cell, Specific cell, or Multiple cells option to specify the cell in which you want to
set the formula.

Nota:
• If you have selected the Specific cell option, specify the address of the cell in the Cell name field.
• If you have selected Multiple cells option, specify the range of the cells in the Cell range field.

• Enter the value to set in the Cell formula field without an "=".

Set cell or text color action
The Set cell or text color action of the Google Sheets package enables you to set the color of the
background or text in a cell. This action sets the color of a cell as RGB values. For example, if you want to
set red color to the background or text in a cell, enter the value 255,0,0.

Impostazioni

• Enter the name of the session used to open the workbook with the Open spreadsheet action.
• To set the color to the current active cell, select Active cell, to set the color to a specific cell, select

Specific cell, or to set the color to multiple cells select Multiple cells.

Nota:
• If you have selected the Specific cell option, specify the address of the cell in the Cell name field.
• If you have selected Multiple cells option, specify the range of the cells in the Cell range field.

• In the Set color to field, to apply color to the background area of the cell, select the Cell option. To
apply color to the text within a specific cell, select the Text within cell option.

• In the Cell color by Name/Code field, specify whether you want to set the cell color by name or as
an RGB value or choose a variable that has the value.

Show worksheet action
The Show worksheet action in the Google Sheets package enables you to show a hidden google sheet in
a worksheet.

Impostazioni

• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l'action Apri foglio
di calcolo.

• Enter the worksheet name in the Google sheet name field.

Nota:  The sheet name should not exceed 31 characters.

Write from data table action in Google Sheets
Use the Write from data table action in the Google Sheets package to write the contents of a data table
variable to a specific spreadsheet.
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Impostazioni

• Inserisci il nome della sessione utilizzata per aprire il foglio di calcolo corrente con l' Apri foglio di
calcolo.

• Seleziona se scrivere sul foglio attualmente attivo o se specificare il nome di un foglio.
• Seleziona la variabile tabella dati.
• Inserisci l'indirizzo della cella da cui iniziare a scrivere i dati.

IBM Watson Authentication package
The IBM Watson Authentication package contains actions that enable you to authenticate the API
token and location URL for each service, while connecting to and disconnecting from your IBM Cloud
account. With this package, you only have to provide your credentials once.

Importante:  This is a beta package and is currently not available with the Automation 360 Enterprise
and Cloud editions.

Prima di iniziare
Each service requires a unique API key and location URL. Log in to your IBM Cloud account to create an
instance of the service to obtain the API Key and location URL. Automation 360 currently includes Speech to
Text.

Actions in the IBM Watson Authentication package

Action Descrizione

Connetti Establishes a connection with the IBM Cloud account. Insert this
action at the beginning of automation sequences that use IBM
Watson packages so that you have to input the credentials only
once. To use this action, select the services to connect with, then
provide the API Key and URL for each service you will use.

Disconnetti Terminates the connection with the IBM Cloud account. Insert this
action at the end of automation sequences that use IBM Watson
packages.

IBM Watson Speech to Text package
This package supports the following audio file formats: flac, mpeg, mp3, ogg, pcm, wav, and webm. The
following languages are supported: Arabic, Brazilian Portuguese, Chinese (Mandarin), English (United
Kingdom and United States), French, German, Japanese, Korean, Spanish (Argentinian, Castilian, Chilean,
Colombian, Mexican, and Peruvian).

Importante:  This is a beta package and is currently not available with the Automation 360 Enterprise
and Cloud editions.
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Funzionalità Descrizione

Detect speakers Identifies the individuals in a conversation between multiple people.
• Supports English, Japanese, and Spanish.
• Use for conversation between two people; maximum six people.
• For best results, use an audio file at least a minute long.

The output contains the words spoken by each speaker and the
timestamp.

Keyword spotting Detects specific strings in the transcript. The output contains the
timestamp(s) for each keyword and a confidence score.

Smart formatting Converts the following types of strings into more conventional
representations to make the transcript easier to read:
• Dates
• Volte
• Series of digits and numbers
• Phone numbers
• Currency values
• Email and web addresses

For examples, see Smart formatting results. This feature supports
English, Japanese, and Spanish.

Profanity filter Obscures profanity by replacing it with asterisks in the transcript.

If package
Utilizza le actions nel package If per controllare la sequenza di esecuzione in base a una o più condizioni di
un'attività.
Utilizza le actions nel package If per verificare se un'applicazione è in esecuzione, se una cartella o un file
esistono, se una variabile corrisponde al valore specificato, se una finestra dell'applicazione esiste o un
computer o un server sono in funzione, prima di eseguire una serie di actions.

Actions nel package If

Il package If include le seguenti actions:

Action Descrizione

Se Vedi If package alla pagina 1625

Else if (optional) Vedi Else if (optional) action alla pagina 1630

Else Vedi Else action alla pagina 1631

Conditions in the If action

Utilizza le seguenti condizioni nell'action If per controllare il flusso di esecuzione in un'attività di
automazione:
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Condizione Descrizione

Applicazione Use the Application is running or Application is not running
condition to run actions based on whether an application is running or not
running.
Enter the application path or specify the path using a variable along with
the amount of time to wait (in seconds) for the condition to be true.

Nota:  The Application is running and Application is not running
conditions are not applicable for Internet Explorer bots because its
corresponding process iexplore.exe runs in the background when
Microsoft Edge is launched in IE mode.

Operatore booleano Utilizza la condizione Variabile booleana per eseguire actions in base al
fatto che una variabile booleana contenga il valore Vero o Falso.
Puoi anche utilizzare questa condizione per confrontare i valori di due
variabili booleane selezionando la seconda variabile da Inserisci una
finestra Variabile.

Data table Utilizza la condizione La tabella dati è vuota per eseguire actions in
base al fatto che la tabella specificata contenga valori.
Use the Number of rows and Number of columns conditions to
execute actions based on whether the number of columns or rows is
Equal to, Greater than, or Less than the specified value.

Data e ora Utilizza la condizione Variabile Data e ora per eseguire actions in base
al fatto che il valore della variabile data e ora di origine sia Uguale a o
Non uguale a, Maggiore di o Uguale a oppure Minore di o Uguale a
il valore della variabile data e ora di destinazione.

Dizionario Use the Check key condition to execute actions based on whether the
value of the specified key is Equal to or Not equal to, or Contains or
Does not contain the target value.

Nota:  The key comparison is case-sensitive.

Utilizza la condizione Controlla se esiste un valore singolo per
eseguire actions in base al fatto che una chiave specifica contenga il valore
di destinazione.

DLL Use the Dll session exists and Dll session does not exist condition to
execute actions based on whether a Dll session is open or closed in a bot.

© 2023 Automation Anywhere. All rights reserved.     1626



    Automation Anywhere - Crea

Condizione Descrizione

File Use the following conditions to execute the action:
• Data del file

Use this condition to verify the date and time when a file was created
or modified. Specify a date or date range using the On a date, Is
within last, Is between, or Is before options. For the On a date
option, specify a date to verify whether the file was created or modified
on that date. For the Is within last option, specify the number of days
or time (in hours, minutes, and seconds). Enter the amount of time (in
seconds) to wait for this condition to be true.

• Il file esiste e Il file non esiste
Use these conditions to execute an action based on whether a file
exists. For example, if a data file exists, format the file and upload it to
a database.

• File extension
Use this condition to check the file extension of a selected file and then
execute actions based on the results. Use the File path field to select a
file.

• Dimensione del file
This condition verifies if the specified file is larger, smaller, not the
same, or the same as the size you specify.
Enter the amount of time (in seconds) to wait for this condition to be
true.

Cartella Utilizza la condizione Cartella esistente o Cartella inesistente per
eseguire un'action in base all'esistenza di una cartella.

Riconoscimento delle
immagini

Use these conditions to verify whether:
• Il File immagine si trova in File immagine oppure non.
• Image file is found in the Window or not.
• Window is found in the Image file or not.
• Window is found in the Window or not.

For the Window conditions, you can use the Resize window option to
specify the window dimensions. This option delivers a more reliable bot.
It resizes the window to the dimensions at which the task was recorded,
which enhances the bot's ability to identify the target object.

Nota:  This option is only available for windows that can be resized. It is
not available for Desktop or Taskbar options.

Per le condizioni Finestra, è possibile utilizzare l'opzione Anteprima per
selezionare una specifica occorrenza acquisita e posizionare il clic rispetto
all'immagine.

JavaScript Utilizza la condizione Script completato o Script non completato per
l'esecuzione di actions in base allo stato del JavaScript specificato. Select
the file that contains the script and optionally specify the parameters by
selecting a list variable.
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Condizione Descrizione

Automazione legacy Le condizioni di Automazione legacy vengono utilizzate solo in bots
migrati per garantire che vengano eseguiti senza problemi in Automation
360. Non consigliamo di utilizzare queste condizioni per lo sviluppo di
nuovi bot. The following conditions to verify the following:
• Se Controllo Web esiste o meno.
• Se Controllo finestra esiste o meno.
• Se Controllo finestra è attivo o meno.
• Se lo Script è completato o meno.
• Se la Finestra figlio esiste o meno.

For the Window control conditions, you can use the Resize window
option to specify the window dimensions. This option delivers a more
reliable bot. It resizes the window to the dimensions at which the task was
recorded, which enhances the bot's ability to identify the target object.

Elenco Utilizza la condizione Variabile elenco per eseguire actions in base al
fatto che una variabile elenco contenga un determinato valore. Il valore
può essere del tipo dati Numero, Stringa o Operatore booleano.

Numero Utilizza la condizione Variabile numero per eseguire actions in base al
fatto che la variabile numero specificata sia Uguale a o Non uguale a o
Maggiore di o Uguale a o Minore di o Uguale a un particolare valore.

Ping Utilizza la condizione Il ping è riuscito o Il ping non è riuscito per
verificare se la macchina o il server sono in esecuzione ed eseguono action
in base al risultato. Enter the amount of time (in seconds) to wait for the
condition to be true.

Registratore • Utilizza la condizione L'oggetto esiste per rilevare un oggetto in una
finestra. Select a window or variable to capture the object. Inserisci la
quantità di tempo (in secondi) da attendere affinché questa condizione
risulti vera, cioè che l'oggetto venga rilevato.

• Utilizza la condizione L'oggetto non esiste per verificare se un
oggetto specifico esiste in una finestra e poi, in base al risultato,
eseguire le actions. Enter the amount of time (in seconds) to wait for
this condition to be true. Per esempio, è possibile utilizzare l'opzione
L'oggetto non esiste all'interno della condizione Loop > While per
essere sicuri che il bot non esegua l'action successiva se non dopo che
l'oggetto dell'applicazione business aziendale sia stato caricato.

Nota:  The Object exists and Object does not exist Recorder
conditions support Chromium-based Microsoft Edge with Internet Explorer
mode.

Servizio Utilizza la condizione Il servizio è in esecuzione o Il servizio non è
in esecuzione per eseguire actions in base al fatto che un servizio sia in
esecuzione o meno. Seleziona Elenco dei servizi per scegliere un servizio
dall'elenco dei servizi disponibili.
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Condizione Descrizione

Stringa Use the String variable condition to execute actions based on whether
the specified source string value is Equal to or Not equal to, or
Includes or Does not include the target value.
È possibile selezionare l'opzione Caso di corrispondenza per eseguire
actions soltanto se le due stringhe hanno lettere maiuscole e minuscole
corrispondenti.
When you extract text from a Microsoft application, the extracted text
contains the /r/n special characters which indicate a new line. Select
the Ignore Carriage return option if you want to ignore the /r special
character when you compare the text.
Per creare una condizione in base al fatto che una stringa sia vuota o
meno, confronta il valore sorgente con un campo di destinazione vuoto
utilizzando l'operatore Uguale a.
Consulta Example of using a conditional statement alla pagina 2058.

Task Bot Utilizza la condizione Attività completata o Attività non completata
per l'esecuzione di actions in base allo stato di Task Bot.

VBScript Usa la condizione Script completato o Script non completato per
l'esecuzione di actions in base allo stato dello script Visual Basic. Select
the file that contains the script and optionally specify the parameters by
selecting a variable.

Finestra Utilizza la condizione La finestra esiste o La finestra non esiste per
verificare se una specifica finestra dell'applicazione è aperta immettendo
il Titolo della finestra o utilizzando una variabile. Enter the amount of
time (in seconds) to wait for the condition to be true. These conditions are
used when the window title remains constant and to verify if the specific
window is open and execute further actions based on the output.
Utilizza la condizione La finestra con lo stesso titolo non esiste o
Esiste una finestra con lo stesso titolo per verificare se esiste una
finestra con lo stesso titolo o se il titolo della finestra è cambiato. Immetti
il tempo (in secondi) per cui continuare a verificare se la condizione è
vera. These conditions are used for window titles that are dynamic. For
example, when you open a Google account webpage, enter your username
and password to log into your account, the window title changes. If
you want to compose a new email as a next action, you can use these
conditions before you execute the next action to verify if the window with
the same title exists or if the title has changed.

Esempio
Build a basic bot that uses a desktop application alla pagina 2052
Esempio di come creare un TaskBot di base che utilizza il package If.

If action
The If action in the If package enables you to specify a condition and hold a sequence of actions to run if
the condition is true.
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Impostazioni

You can configure multiple conditions within a single If action.
1. Fai clic su Aggiungi condizione.
2. Select either of the following options:

• And: Both of the conditions must be met for the  to run.
• Or: Either of the conditions must be met for the  to run.

3. Select the condition from the drop-down list.

Consulta Using If action alla pagina 1630.
Using If action
Use the If Else If and If Else actions to change the flow of execution in an automation task based on
certain conditions.
To use the actions in the If package, do the following:
1. Double-click or drag the If action from the If package in the Actions palette.
2. Select the required condition from the Condition list.

See If package alla pagina 1625 for a list of available conditions.
3. Drag the actions to be executed if the condition is satisfied within the If condition.
4. Double-click or drag the Else If action from the If package in the Actions palette to include

alternative actions to run if the condition for the If action is false, and if the condition for the Else If
action is true.

5. Drag the actions to be executed if the condition is satisfied within the Else If condition.
6. Double-click or drag the Else action from the If package in the Actions palette to include actions to

run if the conditions for the If and Else If actions are false.
7. Drag the actions to be executed if the condition is satisfied within the Else condition.
8. Fai clic su Salva.

Else if (optional) action
The Else if (optional) action in the If package enables you to specify an alternative condition to test if the
condition specified in the If action is false.

Impostazioni

Se questa condizione alternativa è vera, il bot esegue la sequenza di actions contenuta nell'action Else if.
You can configure multiple conditions within a single Else if action.
1. Fai clic su Aggiungi condizione.
2. Select either of the following options:

• And: Both of the conditions must be met for the  to run.
• Or: Either of the conditions must be met for the  to run.

3. Select the condition from the drop-down list.
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Else action
The Else action in the If package enables you to specify the alternative sequence of actions.

Impostazioni

Specifica la sequenza alternativa di actions se la condizione specificata nell'action If e nell'action Else if (se
utilizzata) è falsa.

Image Recognition package
The Image Recognition package contains actions that enable you to search for a user interface (UI)
element in an application based on an image to automate a task in that application.

Actions in the Image Recognition package

Use these actions to automate a task when it is not possible to capture UI elements of applications that
are:
• Exposed over Citrix
• Accessed using the Remote Desktop Protocol (RDP)
• Developed using legacy technology

Image recognition is also useful when object-based recognition does not work or is unreliable. For
example, you can use an image to search for the Close button in an application and perform a left-click
operation.
The Image Recognition package contains the following actions:

Action Descrizione

Trova l’immagine nella finestra Consulta Using Find image in window action alla
pagina 1632.

Trova la finestra nella finestra Consulta Using the Find window in window action
alla pagina 1635.

Registrazione sicura

When secure recording mode is enabled, bots display only the target image but not the source image.
Questo assicura che i dati sensibili non vengano mostrati. To see a preview of the source image in the
Preview window, click the Preview button.

Nota:  The target images are still stored in the Control Room because they are required to run the bots.

Questa impostazione deve essere abilitata da un utente con privilegi di amministratore. Consulta
Impostazioni alla pagina 2721.
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Registrazione sicura

Quando la modalità di registrazione sicura è abilitata, i bots non visualizzano le immagini dell'oggetto di
destinazione dopo l'acquisizione. Questo assicura che i dati sensibili non vengano mostrati.

Nota:  Anche se i bots non visualizzino le immagini di destinazione dopo l'acquisizione, le immagini sono
ancora memorizzate nella Control Room perché sono necessarie per eseguire i bots.

Quando registri un'attività in modalità di registrazione sicura, la finestra Anteprima mostra
temporaneamente un'immagine dell'area acquisita. Questa immagine è nascosta quando ti allontani dalla
finestra Bot editor o la aggiorni.
Questa impostazione deve essere abilitata da un utente con privilegi di amministratore. Consulta
Impostazioni alla pagina 2721.
Riferimenti correlati
Screen resolution dependent packages alla pagina 2730
The screen resolution between the Bot Runner and Bot Creator device should be consistent as when
resolution-dependent packages are used to build bots, any screen resolution difference between the Bot
Creator and Bot Runner device will impact the bots during runtime.

Using Find image in window action
Use the Find image in window action to search for a UI element in an application window (haystack)
using a target image (needle). The target image is an existing image that you can use to search for a UI
element.
To find an image inside an application window, follow these steps:
1. Double-click or drag the Find image in window action from the Image Recognition package in

the Actions palette.
2. Specify the target image (needle) that you want to find in the application window.

• File Control Room: Uses an image file that is available on the Control Room.
• File desktop: Uses an image file that is available on your device.
• Variabile: Uses a file variable to specify the location of the image file you want to use.

Nota:  Images of .jpeg, .jpg, .jpe, .jfif, .bmp, .png, and .gif formats are supported.

3. Specify the window in which you want to find the source image (haystack):
Choose from the Application, Browser, or Variable tab.
Opzione Descrizione

Applicazione Select from a list of currently active windows.
This option shows a list of all the application
and browser windows that are open on the Bot
Creator device.

Browser Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based
, and  browsers. For all other browsers, use the
Application option.

Variabile seleziona una variabile finestra esistente per
specificare il titolo del titolo della finestra
dell'applicazione.
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Inserisci un carattere jolly (*) nel campo Titolo della finestra per cercare i titoli delle finestre che
possono cambiare. You can specify one or more wildcards (*) at the start, middle, or end of the
value.For example, to perform an operation on any window that has Microsoft in the title, use
a wildcard to indicate any string by adding it before or after the value: *Microsoft*. The  first
searches for the exact window title (Microsoft), and if it does not find a match, it searches for
windows with the term Microsoft anywhere in the title.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

4. Opzionale: Seleziona l'opzione Ridimensiona finestra per specificare le dimensioni della finestra.
This option delivers a more reliable bot. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the botto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Nota:  This option is available only for windows that can be resized. Non è disponibile per le opzioni
Desktop o Barra dei comandi.

5. Click Capture region.
The selected window appears.

6. Drag the mouse to select the area and right-click when done.
The captured area appears in the Preview section with the image coordinates underneath.

7. In the Wait in ms before capturing the image field, specify the delay (in milliseconds) before
searching for the image.
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8. Select the Repeat if image not found check box if you want the system to retry searching for the
target image if it is not found.
a) In the Times field, specify the number of times the system must repeat the process to find the

target image.
b) In the Wait between repeats (ms) field, specify the time period the system must wait before

repeating the process of finding the target image.

9. In the Match percentage field, specify the acceptable percentage of matching pixels between the
two images.
For example, if you specify 20 in the field as the match percentage, the system considers the images
as matching even if there is up to 80% of pixel mismatch between the two images.

10. In the Selected match number field, enter a value to specify the occurrence of the target image on
which you want to perform this action.
You can insert a variable when you do not know the number of times the image might appear on the
screen. Ensure you assign variables that support numeric values.

11. Use the Preview option if you want to select an image that is relative (offset) to the existing target
image you are searching on the application screen, or you want to select a specific occurrence if there
are multiple occurrences of the target image.

12. Fai clic su Anteprima.
If a target image occurs multiple times in the Preview window, each occurrence is highlighted in a
rectangular box and displays a number against each occurrence.

13. Select the specific highlighted occurrence, and you can position your click location relative to an
existing image.

Nota:  If there are multiple images on an application screen that you are automating and when the
target image is not easily searchable; in that case, you can select an easily identifiable image in the
captured region and position your click relative to it.

14. If the target image is found multiple times in the captured region. In that case, you can select the
occurrence of a particular target image or select the occurrence number from the drop-down in the
Match number (optional) field on the right pane.
The Match number (optional) and the Target Offset fields on the right pane display the image
occurrence you selected and its offset coordinates of the target image.

15. Fai clic su Invia.
16. In the Target coordinate selections field, the coordinate options Center of match or Offset

from match will be selected automatically based on the action you performed in the Preview
window.
• Center of match: The image is selected based on the coordinates at the center of the matched

image.
• Offset from match: The image is selected based on the coordinates relative to that of the

matched image.

Nota:  The offset coordinates measure the number of pixels from the top left corner of the image.

17. Select an option from the Action to take on target coordinates list to specify the action you want
to perform on the matched image in the application window.

18. Fai clic su Salva.
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Using the Find window in window action
Use the Find window in window action to search for a UI element in an application window using a
screenshot of a window. This action enables you to capture an image of a UI element in an application and
use the captured image to search for that UI element in another window.
To use an image available in an application window to find an image in another application window, follow
these steps:
1. Double-click or drag the Find image in window action from the Image Recognition package in

the Actions palette.
2. Specify the target image (needle) that you want to find in the application window.

Opzione Descrizione

Browser Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based
, and  browsers. For all other browsers, use the
Application option.

Applicazione Select from a list of currently active windows.
This option shows a list of all the application
and browser windows that are open on the Bot
Creator device.

Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Seleziona
l'espressione regolare come Stringa o Modello per ogni condizione di espressione regolare e immetti
il valore. Per impostazione predefinita, il campo Titolo della finestra è sensibile alla distinzione tra
maiuscole e minuscole. You can enable Case insensitive regex flag to identify a window title that is
not case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

3. Click Capture image to capture the target image.
4. Drag the mouse pointer over an area of the application window.

The captured area appears in the Preview section.
5. Specify the window in which you want to find the source image (haystack):

Choose from the Application, Browser, or Variable tab.
Opzione Descrizione

Applicazione Select from a list of currently active windows.
This option shows a list of all the application
and browser windows that are open on the Bot
Creator device.
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Opzione Descrizione

Browser Select from a list of Google Chrome tabs that are
currently open on the Bot Creator device.

Nota:  Currently, this option only supports
Google Chrome tabs. For all other browsers, use
the Application option.

Variabile seleziona una variabile finestra esistente per
specificare il titolo del titolo della finestra
dell'applicazione.

Insert a wildcard character (*) in the Window title field to search for window titles that can change.
You can specify one or more wildcards (*) at the start, middle, or end of the value.
For example, to perform an operation on any window that has Microsoft in the title, use a wildcard
to indicate any string by adding it before or after the value: *Microsoft*. The bot first searches for
the exact window title (Microsoft), and if it does not find a match, it searches for windows with the
term Microsoft anywhere in the title.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Seleziona
l'espressione regolare come Stringa o Modello per ogni condizione di espressione regolare e immetti
il valore. Per impostazione predefinita, il campo Titolo della finestra è sensibile alla distinzione tra
maiuscole e minuscole. You can enable Case insensitive regex flag to identify a window title that is
not case-sensitive.You can enable the Case sensitive option to identify a static window or browser
title and a title with a wildcard character that is case-sensitive and disable the option to identify a
window title that is not case-sensitive.
For example, you can enter the String value as ((\w*)-Notepad for all the window title names
starting with ((\w*)-Notepad, or use Pattern such as ((\w)\s)*document-Notepad for only
those window titles that match this pattern.

6. Seleziona l'opzione Ridimensiona finestra per specificare le dimensioni della finestra.
This option delivers a more reliable bot. It resizes the window to the dimensions at which the task was
recorded, which enhances the bot's ability to identify the target object.
• If the window is maximized when you record the task, this option is unselected.
• If the window is not at the maximum size when you record the task, this option is selected by

default and the width and height fields auto-fill with the window dimensions.

Nota:  This option is only available for windows that can be resized. Non è disponibile per le opzioni
Desktop o Barra dei comandi.

7. Click Capture region.
The selected window appears.

8. Drag the mouse to select the area and right-click when done.
The captured area appears in the Preview section with the image coordinates underneath.

9. In the Wait in ms before capturing window field, specify the delay (in milliseconds) before
searching for the image.

© 2023 Automation Anywhere. All rights reserved.     1636



    Automation Anywhere - Crea

10. Select the Repeat if image not found check box if you want the system to retry searching for the
target image if it is not found.
a) In the Times field, specify the number of times the system must repeat the process to find the

target image.
b) In the Wait between repeats (ms) field, specify the time period the system must wait before

repeating the process of finding the target image.

11. In the Match percentage field, specify the acceptable percentage of matching pixels between the
two images.
For example, if you specify 20 in the field as the match percentage, the system considers the images
as matching even if there is up to 80% of pixel mismatch between the two images.

12. In the Selected match number field, enter a value to specify the occurrence of the target image on
which you want to perform this action.
You can insert a variable when you do not know the number of times the image might appear on the
screen. Ensure you assign variables that support numeric values.

13. Use the Preview option if you want to select an image that is relative (offset) to the existing target
image you are searching on the application screen, or you want to select a specific occurrence if there
are multiple occurrences of the target image.

14. Fai clic su Anteprima.
If a target image occurs multiple times in the Preview window, each occurrence is highlighted in a
rectangular box and displays a number against each occurrence.

15. Select the specific highlighted occurrence, and you can position your click location relative to an
existing image.

Nota:  If there are multiple images on an application screen that you are automating and when the
target image is not easily searchable; in that case, you can select an easily identifiable image in the
captured region and position your click relative to it.

16. If the target image is found multiple times in the captured region. In that case, you can select the
occurrence of a particular target image or select the occurrence number from the drop-down in the
Match number (optional) field on the right pane.
The Match number (optional) and the Target Offset fields on the right pane display the image
occurrence you selected and its offset coordinates of the target image.

17. Fai clic su Invia.
18. In the Target coordinate selections field, the coordinate options Center of match or Offset

from match will be selected automatically based on the action you performed in the Preview
window.
• Center of match: The image is selected based on the coordinates at the center of the matched

image.
• Offset from match: The image is selected based on the coordinates relative to that of the

matched image.

Nota:  The offset coordinates measure the number of pixels from the top left corner of the image.

19. Select an option from the Action to take on target coordinates list to specify the action you want
to perform on the matched image in the application window.

20. Fai clic su Salva.
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Interactive forms package
The interactive forms package contains actions that handle exceptions encountered by a bot. All the
actions performed by users on the interactive forms can be monitored to execute logic using subtasks.
Interactive forms are first-class citizens within the bot repository and have the same workflows for moving
forms between public and private workspaces, and for export or import actions. Handling exceptions
ensures that a bot completes a task when it encounters an error.

Actions in the Interactive forms package

The interactive forms package includes form-level and element-level actions.
The following actions are available at the form level:

Action Descrizione

Display Load and display the selected form.
Select or insert a variable in the Form name field to display the form when an
event is triggered. Optionally, select the check box to always display the form
window in front.

Chiudi Closes the selected form.

Show Loads or displays a hidden form.
Select or insert a variable in the Form name field for a hidden form, which is
displayed on the desktop when an event is triggered.

Hide Hides the selected form from the user's view.

Reset Resets the selected form to its default value.
Select or insert a variable in the Form name field for a form. All the values of
this specified form are reset when an event is triggered.

Validate form Validates all the elements within the selected form.
• Select or insert a variable in the Form name field for a specific form, which

is validated when an event is triggered.
• Select the next event by creating or selecting a variable using the Assign

the return value to a boolean variable field.

Nota:  The Validate form action is not applicable to Rich Text Editor
elements.

Change Form
Title

Changes the title of the selected form.
• Select or insert a variable in the Form name field for a specific form.
• Enter the new title that must appear for the selected form in the New Title

(optional) field.

The following actions are available at the element level:
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Action Descrizione

Assegna Assigns dynamic values to the Dropdown element of a form.
• Select or insert a variable in the Form name field.
• Select the Dropdown element of the form from the Form element field,

which is enabled when an event is triggered.
• Use Assign to set one of the following actions:

• Append: Specified values or variables are added to the selected
Dropdown element.

• Overwrite: Specified values or variables replace the existing data in the
selected Dropdown element.

Nota:  The Assign action is now applicable for the Checkbox and Radio
Button elements in interactive forms.

Enable Enables the specified element of the selected form.
• Select or insert a variable in the Form name field.
• Select a specific element of the form from the Form element field, which is

enabled when an event is triggered.

Disable Disables the specified element of the selected form.

Get Retrieves the value from the specified element of the selected form.
• Select or insert a variable in the Form name field and use the Form

element to select a specific element of the form.
• Use the Returns the value drop-down menu to assign this value to a

variable when an event is triggered.

Create a variable alla pagina 2030

Set Assigns the user-defined or global variable to the selected element of the
specified form.
• Select or insert a variable in the Form name field and use the Form

element to select a specific element of the form.
If you select Table as the Form element, use the Set Value Type to
enable the following additional options:
• Tabella: Sets the variable value to the entire table.
• Row: Sets the variable value to the selected row.

• Use the Input value to assign a user-defined or system variable into this
element when an event is triggered.
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Action Descrizione

Set focus Sets the focus on the selected element of a form.
• Select or insert a variable in the Form name field.
• Use the Form element to select the specific element of the form and set

the focus:
• For form elements such as a text box, text area, number or date, the

cursor appears on the element.
• For form elements such as a check box or radio button, the emphasis is

on the first option.

Highlight Highlights the specified element of the selected form.
• Select or insert a variable in the Form name field.
• Use the Form element to select the specific element of the form to

highlight it when an event is triggered.
• Use the Highlight Type drop-down menu to select one of the following:

• Warning: Displays a warning alert on the specified form element.
• Error: Displays an error alert on the specified form element.

Unhighlight Removes the highlight from the specified element of the selected form.

Change label Changes the label of the selected form element.
• Select or insert a variable in the Form name field.
• Use the Form element to select the specific element of the form for which

the label must change when an event is triggered.
• Enter the name in New label field.

Nota:  The Change label action is now applicable for Button elements in
interactive forms.

Dynamic area

Add row in
Dynamic area

Applies only to forms that have a Dynamic element. This action renders the
selected form field as a single row when the bot starts.
• Select or insert a variable in the Form name field.
• Use the Dynamic area drop-down menu to select the dynamic element of

the form.
• Use Append or Overwrite to add a row for the specified dynamic area.
• Use Add element to insert elements into the dynamic area.

• Use the Type drop-down menu to select the element type such as
Checkbox group, Drop-down, File, Radio group, Snapshot, Text area, or
Textbox.

• Use the Label field to enter a name for the element.
• Click Add to add the element.

You can add up to four elements.
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Action Descrizione

Clear Clears all the dynamic elements in the specified form.

IQ Bot Classifier package
IQ Bot Classifier package enables you to group or classify documents into appropriate learning instances
for content extraction in Automation 360 IQ Bot.

Nota:  IQ Bot Classifier package is available on demand. Contact your Customer Success Manager (CSM)
or Partner Enablement Manager (PEM) for the package. You have to upload this package to Control Room.
Add packages to the Control Room alla pagina 2649

To use your existing bots, you must also add the license when prompted. This package has the following
requirements:
• User must be assigned the IQ Bot Classifier license.
• A Bot Runner user must be associated with role that has Administration > View License permission

enabled.
Create a role alla pagina 2693

• Ensure that the Bot Agent version is not older than the previous two versions.
For example, if you upgrade to Automation 360 v.23 Build 11513 (On-Premises), ensure that the Bot
Agent version is not older than 21.82.10342.
Consulta Compatibilità di Bot Agent alla pagina 1025.

.
The IQ Bot Classifier package enables you to segregate different types of documents into respective
categories. This output can then be used to build logic to merge pages in a document for enhanced data
extraction.
Consulta How to merge documents in IQ Bot Classifier package (A-People login required).

Actions nel package IQ Bot Classifier

The package contains the Classify, Classify documents, and Train Classifier actions. You can use
these actions to create a model file, and use the file to classify uploaded documents into different folders.
These actions work as a precursor to document processing.

Actions Descrizione

Classifica IQ Bot Classify action groups the pages of an input
document based on the model file that was created
using IQ Bot Train Classifier action.
Vedi Using Classify action alla pagina 1642
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Actions Descrizione

Classify documents The IQ Bot Classify document action groups the input
documents based on the first page of each document,
using the selected model file that is created with the IQ
Bot Train Classifier action. Use this action if you are
manually creating document groups.
Vedi Using the Classify document action alla pagina 1643

Train Classifier Vedi Using Train Classifier action alla pagina 1644

Guarda il seguente video per capire come utilizzare il package IQ Bot Classifier:
To learn more, review the courses in IQ Bot Developer learning trail: IQ Bot Developer Training (A-People
login required).
Concetti correlati
Informazioni sul Classificatore alla pagina 2484
Impara come vengono classificati i documenti e i fattori che influenzano la classificazione.

Using Classify action
IQ Bot Classify action groups the pages of an input document based on the model file that was created
using IQ Bot Train Classifier action.
• If you have not done so already, use the Train Classifier action to create a model file. Consulta Using

Train Classifier action alla pagina 1644.
• Ensure the input files are in PDF format. If the input file is an image file (.gif, .jpg, .png, or

.tiff), convert the image to a PDF. Consulta Using ConvertImageToPDF action alla pagina 1649.

Build a bot with the Classify action within a Loop action to iteratively classify each file in the selected
folder.
1. In the Actions palette, double-click or drag the Loop action from the Loop package.
2. In the Loop Type field, select the Iterator option.
3. In the Iterator field, select For each file in folder from the drop-down list.
4. In the Folder path field, select the path to the folder that contains the input files.
5. In the Assign file name and extension to this variable field, create or select a dictionary variable

to store the names and extensions of the files in the selected folder path.
For this example, we will use a dictionary variable named dictFile.

6. In the Actions palette, double-click or drag the Classify action from the IQ Bot Classifier package.
7. In the Input file field, enter a dynamic file path using a variable.

a) Add a file path pointing to the folder, for example C:\input\.
b) Add the dynamic file name string: $dictFile(name)$.$dictFile(extension)$.

Nota:  Be sure to include a period between the variable holding the file name and the one
holding the extension.

The name and extension keys are predefined. When inserted and run in a loop, the action iterates
through the entire folder and calls the files in the folder one at a time. The Input file value looks like
this: C:\input\$dictFile(name)$.$dictFile(extension)$

8. In the Classifier field, provide the file path to the model file.
You can either select the .zip folder or extract the .icmf file from this folder and select it.
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Nota:  For better classification results and performance, we recommend that you use the .icmf file
available in the .zip folder obtained from the Train Classifier action.

9. Use the Output folder path option to save the classification output document.
10. Opzionale: Configure the following ADVANCED SETTINGS:

• Confidence threshold (%): If the confidence value of the category prediction of a page is less
than the confidence threshold, it is moved to the Unclassified folder.

• Save classification output variable: Save the classification results as a list of dictionaries with
the following keys:
• fileName
• pageIndex
• Categoria
• confidence

Nota:
• You can select the type of classification in the IQ Bot Classifier:

• Image-based classification
• Text-based classification
• Both image and text-based classification

• To project a higher confidence threshold, we suggest that you calculate the confidence threshold
when the document pages are similar. To determine the required confidence threshold, you can
review the confidence values from the classification output.

• The IQ Bot Classifier can auto-detect the language for classification, and supports all languages
supported by ABBYY (an optical character recognition application).

11. Click Save and Run.
The pages from the output document are saved in the respective subfolders, based on the categories
created in the model file. Any previously-classified documents in the output folder will be overwritten.

You can use each subfolder of similar documents to create and train a learning instance to extract data
from the documents. Consulta Creare un'istanza di apprendimento alla pagina 2487.

Using the Classify document action
The IQ Bot Classify document action groups the input documents based on the first page of each
document, using the selected model file that is created with the IQ Bot Train Classifier action. Use this
action if you are manually creating document groups.
• Build and run a bot with the Train Classifier action to create a model file. Consulta Using Train

Classifier action alla pagina 1644.
• Create a new document group alla pagina 2486

1. In the Actions palette, double-click or drag the Classify document action from the IQ Bot
Classifier package.

2. In the Input file field, provide the default filepath for incoming files for classification.
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3. In the Classifier field, provide the filepath of the model file.
You can either select the .zip folder or extract the .icmf file from this folder and select it.

Nota:  For better classification results and performance, we recommend that you use the .icmf file
available in the .zip folder obtained from the Train Classifier action.

4. Use the Output folder path option to save the classification output documents.
The pages from the output document are saved in the respective subfolders based on the categories
created in the model file.

5. Opzionale: Configure the Confidence threshold (%).
If the confidence value of the category prediction of a document is less than the confidence threshold,
the document is moved to the Unclassified folder.

6. Select from Normal mode or Express mode.
• Normal mode: The Classifier parses the entire document and groups it based on the fields in all

the pages.
• Express mode: The Classifier groups the document based on the fields in the first page.

7. Seleziona o crea una variabile elenco per mantenere l'output.
The classification results as a list with the following keys:
• fileName
• pageIndex
• Categoria
• confidence

Using Train Classifier action
Use the Train Classifier action to create a model file that is used by the Classify action to sort the
documents into required categories for input.
Before building the bot, collect example documents and categorize them into folders. Ensure the set of
example documents meets the following requirements:
• Has at least two categories.
• A minimum of 15 pages per category (20 pages recommended).
• Split input PDF documents that have multiple pages into single-page PDF documents. Consulta Using the

Split document action alla pagina 1739.
For example, if you have a PDF document that has three pages, split it into three single-page PDF
documents.

If these minimum requirements are not met, an error message is displayed during bot runtime.
Each folder has a selection of documents that are a sample of the documents that the associated learning
instance will process. The Train Classifier action will read through the files in the folders, and build a
model based on the documents stored inside each folder.

Nota:  As ABBYY FineReader Engine OCR is now downgraded to version 12.2 from version 12.4, older
.icmf files cannot be used to retrain models in Automation 360 v.24 of the IQ Bot Classifier package. If
you want to add more categories or more files into your existing categories, you must create a new model.

1. In the Actions palette, double-click or drag the Train Classifier action from the IQ Bot Classifier
package.

2. Click Train to continue creating a new model file.
3. Opzionale: If you have an existing model file, click Re-Train.
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a) Use the Training folder path field to select an existing folder path from the Desktop folder
tab.
Alternatively, click the Variable tab to manually enter an existing training folder path.

b) Use the Existing zip path field to select the filepath of the .zip folder from Control Room file
or Desktop file tab.
Alternatively, click the Variable tab to manually enter the path for the .zip folder.

Nota:  When you train documents, a .zip folder is created, which contains .icmf, .data and
.properties files. Ensure you upload the entire .zip folder for retraining an existing model
file.

4. Select the input folder path from Desktop folder or Variable.
The input folder path must have subdirectories with the names that correspond to the category of the
documents that you want to train the classifier on. For example, if you have sales-related documents,
the input folder path must have subfolders such as Invoice and Purchase Order.

5. Opzionale: If you select Desktop file, click Browse to change the default filepath.
6. Enter a name for the model file in the Model name field.
7. Use the Model output path field to select the directory for the output model file.
8. Opzionale: Configure the following ADVANCED SETTINGS:

a) Training Optimization: Use the drop-down menu to select the type of training optimization.
• Precision: select this option when you want your training model to be precise but can miss

out on few documents.
• Recall: select this option when you want the training model to find all the relevant cases

within a dataset.
• F1 score: is selected by default and the recommended setting as it combines the training

optimization of both Precision and Recall.

F1 score is the selected by default. Precision and Recall.
b) Classification Type: Use the drop-down menu to select the features you want to include such

as text, image, or both.
Text and image is selected by default. If you select Text or Text and image, list of supported
languages is displayed in the Recognition Language drop-down menu.

c) OCR Settings: The Extract all text blocks and Extract text from images are enabled by
default.
With the OCR Settings enabled by default, more time is consumed by OCR in extracting the
content. This ensures that relatively lower quality documents are also handled based on the
inputs from OCR.

9. Click Save and Run.
The model is created as a .icmf file in the directory specified in the Model output path field.

After creating the model, build a bot to classify input documents. Vedi Using Classify action alla pagina
1642

IQ Bot [Local Device] package
Avoid having to manage a separate IQ Bot cluster setup by leveraging your existing pool of RPA devices
and process documents using multiple Bot Runners.
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Nota:  This package is deprecated from Automation 360 v.22 (Build 10526). IQ Bot Extraction package
provides all the capabilities provided by the IQ Bot [Local Device] package along with some improvements.
IQ Bot Extraction package has Process Documents action that is similar to IQ Bot [Local Device]
package. So before using the IQ Bot Extraction package, ensure that you update the bots associated with
the Process Documents action of the IQ Bot [Local Device] package by performing the following steps:
1. Open the bot.
2. Copy or save the configured settings for the Process Documents action.
3. From the IQ Bot Extraction package, drag the Process documents action into the workflow.
4. Apply the settings you copied or saved from the Process Documents action of the IQ Bot [Local

Device] package.
5. Delete the Process Documents action of the IQ Bot [Local Device] package from the workflow.
6. Salva il bot.

Additionally, ensure that you update the output folders according to the following folder structure:
• Operazione riuscita: Contains the processed CSV files.
• Convalida: Contains the documents as CSV files that have failed the validation rules.
• Ripetizione: Contains documents that must be retrained because of one of the following conditions:

• Se un bot non è disponibile, nella cartella viene copiato il documento originale.
• Se la convalida non riesce, nella cartella viene copiato il documento originale.

• Non elaborato: Contains documents that encountered errors during processing.

Prima di iniziare

IQ Bot [Local Device] package helps you scale by processing documents on multiple devices
simultaneously using a device pool. You can set this up using workload management in the Control Room.
Gestione del carico di lavoro alla pagina 2797
• If you are using a device pool, then you have to set up a shared file system so that all the Bot Runners

can process and store documents at the same location.
• This command performs parallel processing at the folder level, so you have to set up input files in

separate folders.
• You must have the IQ Bot Services role along with the Bot Runner role to run bots in production. This is

required so that the Bot Runner can access the IQ Bot server when using a device pool.
• The package does not create new groups and the documents that do not match the existing groups are

sent to IQ Bot Validator on the IQ Bot server.

Actions nel package IQ Bot [Local Device]

The package includes the following action:

Action Descrizione

Process Documents Vedi Using Process Documents action alla pagina
1647
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Concetti correlati
IQ Bot Extraction package alla pagina 1654
Capability to automatically extract values provides enhanced content extraction from invoices.
Attività correlate
Utilizzo dell'action Elabora documenti IQ Bot alla pagina 1661
Utilizza questa action per estrarre i valori dalle fatture utilizzando un modello preformato.

Using Process Documents action
Use the action to process documents using TaskBots created in the Control Room.
1. In the Actions palette, double-click or drag the Process Documents action from the IQ Bot [Local

Device] package.
2. In the right-side pane, select the learning instance from the drop-down list.

You can click the refresh option to view the updated list.
Only the ABBYY FineReader Engine and Tesseract4 OCR engines are currently supported.

3. Enter the Input documents folder path.
• Enter the folder path as text or choose a folder using the Browse option.
• Either enter a variable name or click Variable to select a variable from the list.

4. Enter the Output folder path path.
• Enter the folder path as text or choose a folder using the Browse option.
• Either enter a variable name or click Variable to select one from the list.

5. Select the Validator settings check box if you want to review documents in the IQ Bot Validator.
When you enable this setting, documents are stored in the IQ Bot server's output path. To download
documents back to your local device, use the Download all documents action in the IQ Bot
package.
Azione Download all documents (Scarica tutti i documenti) alla pagina 1662
The following types of documents are sent to the IQ Bot Validator:
• Failed documents (exceptions)
• Unclassified documents
• Documents that do not belong to any group

Nota:  If you do not want to use the IQ Bot Validator, do not enable this setting. You can build your
own Validator using Interactive forms and the dashboards on Bot Insight.
Using interactive forms alla pagina 2186

6. Fai clic su Salva.

IQ Bot Pre-processor package
Use the IQ Bot Pre-processor package to extract content from documents or process image files before
they are sent to Automation 360 IQ Bot.

Nota:  This package is not available as part of the standard Automation 360 IQ Bot installation. Per
scaricare e installare questo package, esegui queste operazioni:
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1. Download the package from the Automation Anywhere support site:
A-People Downloads page (Login required)

The package is a .jar file available in the IQ Bot installation folder.
2. Carica il package su Control Room.

Add packages to the Control Room alla pagina 2649

Nota:  Ensure that the Bot Agent version is not older than the previous two versions.
For example, if you upgrade to Automation 360 v.23 Build 11513 (On-Premises), ensure that the Bot Agent
version is not older than 21.82.10342.
Consulta Compatibilità di Bot Agent alla pagina 1025.

After installation, administrator can locate the package in Automation 360: Manage > Packages.
Windows Media Foundation platform must be installed on your Bot Runner machine in order to use the
following actions without any errors.

Actions nel package IQ Bot Pre-processor

The following table lists the actions used for processing image file:

Actions Descrizione

ConcatenateImages Vedi Using ConcatenateImages action alla pagina 1648

ConvertImageToPDF Vedi Using ConvertImageToPDF action alla pagina 1649

EditImage Vedi Using EditImage action alla pagina 1649

EnhanceImage Vedi Using EnhanceImage action alla pagina 1651

OrientImage Vedi Using OrientImage action alla pagina 1653

The following table lists the actions used for extracting content from documents:

Actions

GetBarCodes Vedi Using GetBarCodes action alla pagina 1650

GetDocumentInfo Vedi Using GetDocumentInfo action alla pagina 1650

GetPageContent Vedi Using Get page content action alla pagina 1651

To learn more, review the courses in IQ Bot Developer learning trail: IQ Bot Developer Training (A-People
login required).

Using ConcatenateImages action
Use the ConcatenateImages action in the IQ Bot Pre-processor package to link two image files.
1. Drag the IQ Bot pre-processor > ConcatenateImages action into your workflow.
2. Use the Input file path 1 field to select the first input file from Control Room file, Desktop file or

Variable.
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3. Opzionale: If you selected Control Room file or Desktop file, click Browse to change the default
filepath.

4. Use the Input file path 2 field to select the second input file.
5. Select the output folder from the Output Path field.
6. Opzionale: Click Browse to change the default output filepath.
7. Use the Concatenate Type field to select one of the following options:

• Vertical: To vertically concatenate or link the selected images.
• Horizontal: To horizontally concatenate or link the selected images.

8. Opzionale: Use the Assign output status to variable field to set the output status of action during
bot runtime.

9. Fai clic su Salva.
When the bot runs successfully, the combined image file is saved in the specified output folder.

Using ConvertImageToPDF action
Use the ConvertImageToPDF action in the IQ Bot Pre-processor package to convert a selected image
file to a text-enabled PDF document. The converted PDF file retains the name of the input image file by
default.
1. Drag the IQ Bot pre-processor > ConvertImageToPDF action into your workflow.
2. Select the input file from Control Room file, Desktop file or Variable.
3. Opzionale: If you selected Control Room file or Desktop file, click Browse to change the default

filepath.
4. Use the Output Path field to select the output folder for the PDF document.
5. Opzionale: Click Browse to change the default output filepath.
6. Opzionale: Choose from the following advance settings:

• Input file settings: Use this field to select various input file settings.
For example, if the input file is a legal document (a bank check), select the Has MICR check box.

• Process settings: Use this field for processing the output file.
For example, select the Process text blocks independently check box if the OCR engine must
process various blocks of the input file as a specific text type.

7. Opzionale: Use the Save the output status of the action as boolean to set the output status.
8. Fai clic su Salva.

When the bot runs successfully, the processed PDF file is saved in the specified output folder.

Using EditImage action
Use the EditImage action in the IQ Bot Pre-processor package to resize an image file.
1. Drag the IQ Bot pre-processor > EditImage action into your workflow.
2. Select the input file from Control Room file, Desktop file or Variable.
3. Opzionale: If you selected Control Room file or Desktop file, click Browse to change the default

filepath.
4. Use the Output Path field to select the output folder.
5. Opzionale: Click Browse to change the default output filepath.
6. Use the Select Image Edits drop-down menu to select one of the following options:

• Crop: Use an auto-crop or manual option to crop the image.
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• Resize: Change the height and width of the image.

7. Opzionale: Use the Assign output status to variable field to set the output status of action during
bot runtime.

8. Fai clic su Salva.
When the bot runs successfully, the edited image file is saved in the specified output folder and is
suffixed by the word processed.
For example, if the image filename is Sales.png, the processed file is saved as
Sales_processed.png

Using GetBarCodes action
Use the GetBarCodes action in the IQ Bot Pre-processor package to detect and extract all available
barcodes from a document.
1. Drag the IQ Bot pre-processor > GetBarCodes action into your workflow.
2. Select the input file from Control Room file, Desktop file or Variable.
3. Opzionale: If you selected Control Room file or Desktop file, click Browse to change the default

filepath.
4. Use the List of dictionaries with 7 keys drop-down menu to select the output format for the

extracted strings.
If the document has multiple barcodes, multiple dictionaries are used as each dictionary corresponds
to a single barcode. Each dictionary has the following seven keys that relate to the various attributes
of the barcode in a document:
• Page number of the document where a barcode is available
• Type of the barcode
• Value of the barcode
• X coordinate of the barcode
• Y coordinate of the barcode.
• Width of the barcode
• Height of the barcode

5. Fai clic su Salva.
When the bot runs successfully, the extracted barcodes are assigned to the output variable.

Using GetDocumentInfo action
Use the GetDocumentInfo action in the IQ Bot Pre-processor package to extract document information
such as the page count and extension type.
1. Drag the IQ Bot pre-processor > GetDocumentInfo action into your workflow.
2. Select the input file from Control Room file, Desktop file or Variable.
3. Opzionale: If you selected Control Room file or Desktop file, click Browse to change the default

filepath.
4. Use the Dictionary object with 5 keys drop-down menu to select the output format for the

extracted information.
Each dictionary has the following five keys that relate to the various attributes of the document:
• Filepath of the document location
• Extension type of the document
• File type of the document
• Total number of pages in the document
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• File size of the document

5. Fai clic su Salva.
When the bot runs successfully, all the extracted information for the selected document is assigned to
the output variable.

Using Get page content action
Use the Get page content action in the IQ Bot Pre-processor package to extract text from a specific page
of a document (PDF, image file) into a list of strings.
1. Drag the IQ Bot pre-processor > Get page content action into your workflow.
2. Select the input file from Control Room file, Desktop file or Variable.
3. Opzionale: If you selected Control Room file or Desktop file, click Browse to change the default

filepath.
4. Enter the page number of the selected document from which the content must be extracted.
5. Use the List of strings extracted from page drop-down menu to select the output format for the

extracted strings.
You can use this menu to create a variable with Type > List and Subtype > String. Alternatively,
you can select an existing variable with Type > List, and Subtype > String or Subtype > Any.

6. Fai clic su Salva.
When the bot runs successfully, the content extracted from the specific page of the selected document
assigned to the output variable.

Using EnhanceImage action
Use the EnhanceImage action in the IQ Bot Pre-processor package to enhance a selected image file.
1. Drag the IQ Bot pre-processor > EnhanceImage action into your workflow.
2. Select the input file from Control Room file, Desktop file or Variable.
3. Opzionale: If you selected Control Room file or Desktop file, click Browse to change the default

filepath.
4. Use the Output Path field to select the output folder.
5. Opzionale: Click Browse to change the default filepath.
6. Opzionale: Click Add effect and use Effect type drop-down menu for image enhancement options.

For more information on the available options, see Image enhancement options in EnhanceImage action
alla pagina 1652.
Consider a scenario where you have uploaded a low quality image. Use the following options to
improve the clarity and increase the brightness:
• Select Effect type > SHARPEN.

Additional fields associated with sharpening an image such as Gaussian blur, Alpha, Beta and Gama
are displayed.

• For this example, enter 5 in the Alpha field.
Value between 0 to 10 can be used in the additional fields. Optionally, you can also press F2 or
click Insert a value option to select a system value.

• Select Effect type > BRIGHTNESS.
• Enter 7 in the Brightness factor field.

The selected enhancement options are listed in the Effect type field, and you can edit or delete a
specific effect type.

7. Fai clic su Aggiungi.
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8. Opzionale: Use the Assign output status to variable field to set the output status of action during
bot runtime.

9. Fai clic su Salva.
When the bot runs successfully, the enhanced image file is saved in the specified output folder.

Image enhancement options in EnhanceImage action
Improve the quality of an image that you have uploaded in the EnhanceImage action by using additional
options available.

Opzione Usa

Grayscale Convert the color pixels in an image to grayscale.
Recommended: Convert color images to grayscale to improve the OCR
extraction accuracy.

Blur Smoothen out areas that are pixelated and improve image quality.
Recommended values: Any odd number (such as 3, 7, and 11), as long
as it is less than the pixel size of the uploaded image.

Sharpen Improve clarity by removing distorted and blurred aspects of the original
image.
Consider a scenario where you have an image file called ImageA. When
you apply Gaussian blur = 5 to this image, a blurred version of this
image is created called ImageB. You can then use the following Sharpen
parameters:
• Alpha: 3
• Beta: -1
• Gamma: 0

The following formula is applied for output:
Output = ImageA*Alpha + ImageB*Beta + Gamma
Where:
• ImageA: First input array (Input image)
• Alpha: Weight of the first array elements
• ImageB: Second input array image with the same size and channel

number as ImageA
• Beta: Weight of the second array elements
• Gamma: Scalar added to each sum

Nota:  The principal use of the preceding equation is to sharpen an
image by removing the blurriness from the original image.

Recommended values:
• Gaussian blur: 0 to 10
• Alpha: 1 to 15
• Beta: -0.5 to -5
• Gamma: 0 to 50
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Opzione Usa

Denoise Smoothen out pixels that are not grayscale to remove distortion or
speckling from the image.
Recommended value: 21. However, it can be any odd number as long
as it is less than the pixel size of the uploaded image.

Contrast Increase or decrease the contrast of the pixels. Values can range from 0
(no change) to 2 (maximum contrast).
Recommended values: From 0.8 through 2.

Brightness Increase or decrease the brightness level of all the pixels in the image.
Values can range from -100 (minimum contrast) to 100 (maximum
contrast), with 0 representing no change.
Recommended values: From 0 through 100

Thresholding A form of image segmentation. Thresholding is an image processing
method that creates a bi-tonal (binary) image by setting a threshold
value on the pixel intensity of the original image. In image processing,
thresholding is typically used to separate objects or foreground pixels
from background. For example, the following image has been processed
using Thresholding value as 200 and 100 respectively.

Recommended value: From 0 through 255

Remove RGB Provide upper and lower bound values to pixels in a color image. Pixels
in a color image are represented by three primary color channels: red,
green, and blue (RGB). The output of this effect is a binary image with
pixels that are black (0) or white (255). Consider a scenario where you
want to transform high-intensity red pixels in the range of 200 to 255 to
white (255). You can set the lower bound for red to (200,0,0) and upper
bound to (255,0,0).

Using OrientImage action
Use the OrientImage action in the IQ Bot Pre-processor package to change the orientation of a selected
image file.
1. Drag the IQ Bot pre-processor > OrientImage action into your workflow.
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2. Select the input file from Control Room file, Desktop file or Variable.
3. For the Control Room file and Desktop file tabs, click Browse to change the default filepath.
4. Use the Apply settings field to change the following orientation options:

• Flip: Use the drop-down menu to flip the image horizontally, vertically, or horizontally and
vertically.

• Rotate: Use the drop-down menu to:
• Rotate the image clockwise or anti-clockwise.
• Change the angle of the image.

For example, enter 45 if you want to change the image angle by 45 degrees.

5. Fai clic su Salva.
When the bot runs successfully, the modified image file is saved in the specified output folder.

IQ Bot Extraction package
Capability to automatically extract values provides enhanced content extraction from invoices.
L'istanza di apprendimento è un ambiente IQ Bot che consente di formare documenti di esempio per
l'estrazione dei contenuti. Perfezionando costantemente l'istanza di apprendimento, è possibile ottenere
un'elevata precisione nell'estrazione dei contenuti prima di distribuire l'istanza di apprendimento in un
ambiente di produzione.
Il package IQ Bot Extraction combina un'istanza di apprendimento (nuova o esistente) e un modello
di apprendimento automatico preformato per estrarre automaticamente i contenuti. Il modello di
apprendimento automatico preformato utilizza punti dati per estrarre contenuti dai tipi di documenti
supportati. Fornendo una formazione aggiuntiva a un'istanza di apprendimento esistente, è possibile
estrarre contenuti anche da altri tipi di documenti.

Nota:  This package is deprecated from Automation 360 v.26. IQ Bot Document Automation provides all
the capabilities provided by the IQ Bot Extractionpackage. To move your bots from the IQ Bot Extraction
package to Document Automation, see Move from IQ Bot Extraction package to Document Automation alla
pagina 1657.

The following diagram shows the IQ Bot Extraction package workflow:
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Contact your Customer Success Manager (CSM) or Partner Enablement Manager (PEM) for more
information on the high level architecture, design and folder structure.
High level architecture, design overview, folder structure of IQ Bot Extraction package (A-People login required)

Il package IQ Bot Extraction fornisce i seguenti metodi di estrazione:
Estrazione dei contenuti con una formazione minima
Il package IQ Bot Extraction è progettato per estrarre valori con una formazione minima da un tipo di
documento specifico, ad esempio una fattura o un ordine di acquisto.

Nota:  Per questo metodo di estrazione del contenuto, assicurati di utilizzare sempre il motore OCR ABBYY
FineReader Engine 12.4.

Considera uno scenario in cui desideri estrarre i dati di vendita da varie fatture. Crea un'istanza di
apprendimento selezionando un dominio o un tipo di documento preformato utilizzato per estrarre i dati. In
questo scenario, puoi selezionare il tipo di documento fattura, che fornisce una serie di campi preimpostati
per l'estrazione del contenuto. Assicurati di caricare un esempio di documento di fattura come riferimento.
Non è richiesta alcuna formazione aggiuntiva sul gruppo di istanze di apprendimento. Utilizza il package
IQ Bot Extraction per collegare questa istanza di apprendimento al bot. Puoi eseguire questo bot per
recuperare i dati di vendita in base ai campi preimpostati per le varie fatture.
Estrazione migliorata con formazione aggiuntiva
Il package IQ Bot Extraction utilizza una combinazione di motore back-end con server IQ Bot per
una migliore estrazione dei documenti. Puoi utilizzare un'istanza di apprendimento esistente per
fornire formazione aggiuntiva a tutti i gruppi di documenti disponibili. Personalizzando i vari campi e le
impostazioni di convalida del gruppo di istanze di apprendimento, puoi utilizzare questo package per
l'estrazione di contenuti in altri tipi di documenti.

Importante:  This package is not available as part of the standard Automation 360 IQ Bot installation. Per
scaricare e installare questo package, esegui queste operazioni:
1. Scarica il package dal sito del supporto di Automation Anywhere. Il package è un file .jar disponibile

nella cartella IQ Bot Installazione e configurazione.
A-People Downloads page (Login required)

2. Carica il package su Control Room.
Add packages to the Control Room alla pagina 2649

Prima di iniziare

• Ensure you create a learning instance using a supported OCR.
• Seleziona i documenti con layout comuni.

The preset model contains logical group. È importante selezionare un gruppo esistente per le regole di
convalida predefinite al fine di evitare documenti con errori nella cartella Operazioni riuscite.

• Ensure that the Bot Agent version is not older than the previous two versions.
For example, if you upgrade to Automation 360 v.23 Build 11513 (On-Premises), ensure that the Bot
Agent version is not older than 21.82.10342.
Consulta Compatibilità di Bot Agent alla pagina 1025.
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Action nel package IQ Bot Extraction

Per creare un bot per l'estrazione dei dati, è disponibile l'action che segue:

Action Descrizione

Estrazione di IQ Bot Consulta Utilizzo dell'action Elabora documenti IQ Bot alla
pagina 1661.

Guarda il seguente video per capire come utilizzare il package IQ Bot Extraction:
Attività correlate
Selezione di un motore OCR alla pagina 2490
You can select an OCR engines that suits your requirement for data extraction based on your document
types. Restarting IQ Bot services is not necessary for implementing an engine change.

Move from IQ Bot Extraction package to Document Automation
As of the Automation 360 v.26 release, the IQ Bot Extraction package will be deprecated. Instead,
configure your learning instances from Automation 360 IQ Bot to extract data in the new document
processing solution, Document Automation.
Check if any bots in use the IQ Bot Extraction package: Navigate to Manage > Packages, and
search for the IQ Bot Extraction package. If the status is Enabled, you must do steps on this page to
identify the bots that contain the Process documents action and the associated learning instances, and
configure those learning instances to run in Document Automation.

Set up your Set up your Document Automation environment alla pagina 2562, which includes creating a
custom role and users to perform tasks in Document Automation.
In this page, you connect your learning instances from Automation 360 IQ Bot, build a bot to upload
documents to Document Automation, publish the learning instance assets, and deploy them to a Bot
Runner.
1. Identify the learning instances that you must connect to Document Automation:

a) Navigate to Automation page, under the Public tab, locate the Bots folder.
b) Click on a TaskBot to open the Bot editor.
c) If the TaskBot contains the IQ Bot Extraction > Process documents action, locate the

Learning instance name field and note the value. This is the name of the learning instance that
you must connect to Document Automation.

d) Repeat these steps to identify all the learning instances that must be connected to Document
Automation.

Connect your learning instances to Document Automation
Quando connetti un'istanza di apprendimento creata in Automation 360 IQ Bot, il sistema crea le
risorse dell'istanza di apprendimento (bots RPA, processo AARI e modulo) per consentire all'istanza di
apprendimento di iniziare a elaborare i documenti in Document Automation.
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Nota:
• This feature is available only for Document Automation customers. It is not available in Community

Edition.
• L'ambiente Automation 360 IQ Bot deve essere associato alla Control Room dove Document Automation

è installato. Inoltre, Automation 360 IQ Bot deve disporre di una versione compatibile con la Control
Room.

• È possibile collegare un'istanza di apprendimento alla volta.

2. Login to the Control Room as the Admin user. Navigate to Manage > Learning Instances. Click
Connect learning instance.
This takes you to Connect Learning Instances from IQ Bot classic page which contains a list of
Automation 360 IQ Bot learning instances.

3. Seleziona l'istanza di apprendimento dalla versione Automation 360 IQ
Bot con cui connetterti. Move it from left to right. Fai clic su Connetti.

The newly-connected learning instance appears in the Learning instances table in private mode.
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4. Upload documents to the learning instance that you connected in the previous step to test its
extraction capability.
a) Fai clic su Elabora documenti.

b) Nella finestra Elabora documenti, fai clic su Sfoglia per selezionare i file da caricare.
c) In the Download data to field, enter the file path that will hold extracted data.

When the process runs, it creates the following three folders in the provided file path:
• Success: Contains the extracted data in the specified format (CSV or JSON).
• Invalid: Holds documents marked invalid.
• Failed: Holds documents that could not be processed.

You can provide an output folder path based on one of the following options:
• Opzione 1: Il percorso del dispositivo locale se hai configurato l'elaborazione e la convalida del

documento sullo stesso dispositivo.
Questa opzione viene in genere utilizzata quando si esegue il test dell'istanza di
apprendimento.

• Opzione 2: Il percorso della cartella condivisa se hai impostato la convalida distribuita su
dispositivi separati.
Questa opzione viene in genere utilizzata per le istanze di apprendimento pubblicate. Ad
esempio \\10.239.192.60\Sharepath\Output.

d) Fai clic su Elabora documenti.
The Bot Runner window appears. The window disappears when the documents are done
processing. Refresh the Learning instances table to see the updated metrics.

If there is a value next to the Validate documents link, you must manually validate the document fields.
Otherwise, proceed to step 3.
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5. Fix the validation errors
a) Fai clic su Convalida documenti.

The AARI Task Manager opens in a new tab, with the first failed document in queue. For an
introduction to the Validator user interface, see Using the AARI Task Manager Validator for Document
Automation alla pagina 2593.

b) Review each field to verify the data type and extracted value.
Document Automation supports the following data types: text, number, time, and check box
Alternatively, from the drop-down list on the right panel, you can select Show fields that need
validation.

Nota:  When documents are awaiting validation, if you edit the learning instance, click
Reprocess to reattempt extraction.
Reprocessing documents does not affect the uploaded documents metric.

c) Update the fields with errors.
Click the field or draw a box around the values that you want to extract.
For Automation Anywhere pre-trained models, you can configure the learning instance to extract
specific values in a field and ignore others. Per ulteriori informazioni, consulta Using validation
feedback to extract specific values in a table alla pagina 2573.

• To skip a document without correcting errors, click Skip to proceed to the next document in
the validation queue.

• Per rimuovere un documento che non può essere elaborato, fai clic su Contrassegna come
Non valido.

d) After you make the necessary corrections, click Submit so that the document can finish
processing.
The next document in queue appears. When all the documents are corrected, the system displays
a message stating that no more tasks are available.

e) Chiudi la scheda per tornare alla pagina Istanze di apprendimento.

6. Verificare i risultati dell'output:
a) Open the file in the Success folder that contains the extracted data and review the results to

ensure that it matches your use case.
b) Opzionale: Review the Learning Instance dashboard.

The dashboard displays the total number of uploaded documents and the number of documents
pending validation.

Configure the learning instance to process documents in production
7. Build the Extraction-Scheduler bot to automate uploading documents to the learning instance:

Build a bot to upload documents to Document Automation alla pagina 2587
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8. Publish the process.
a) Navigate to Automation > Private tab > Bots > Document Workspace processes and

select the folder with the same name as the learning instance.
b) Mouse over the vertical ellipses to the right of the process to open the actions menu and click

Check in process.
The Check in Process window opens with the bots and form auto-selected to also be checked
in.

c) In the Check in Process window, add your comment and click Check in.
The process appears in the same folder structure in the public workspace.

See these steps in a video:

9. Publish the Extraction-Scheduler bot.
a) Locate the Extraction-Scheduler bot in the private tab.
b) Mouse over the triple ellipses to the right of the bot to open the menu and click Check in Task

bot.
The Check in Task bot page opens with the bot auto-selected.

c) Add a comment and click Check in.

10. Login as the Document Automation Admin user to deploy the process and bots to unattended Bot
Runner devices: Deploy the learning instance assets alla pagina 2592

Build a bot to upload documents to a specific learning instance for processing and extraction: Build a bot to
upload documents to Document Automation alla pagina 2587

Utilizzo dell'action Elabora documenti IQ Bot
Utilizza questa action per estrarre i valori dalle fatture utilizzando un modello preformato.
1. Trascina l'action Elabora documenti nel flusso di lavoro.
2. Utilizza il menu a discesa Nome dell'istanza di apprendimento per selezionare un'istanza di

apprendimento esistente.
3. Seleziona una delle seguenti schede per i documenti di input:

• Cartella desktop: inserisci il percorso cartella o fai clic su Sfoglia per scegliere una cartella.
• Variabile: inserisci un nome di variabile o sfoglia per selezionare una variabile dall'elenco.

4. Seleziona la cartella (invece di un singolo documento) che contiene tutti i documenti da elaborare.
5. Seleziona la cartella di output dal campo Percorso della cartella di output.
6. Opzionale: Seleziona la casella di controllo Invia documenti a IQ Bot Validator per la convalida.

Anche se i documenti vengono elaborati utilizzando Bot Runners sul computer locale, è necessario
utilizzare questa opzione se desideri convalidare i documenti nel IQ Bot Validator.

7. Opzionale: Nel campo Etichetta del gruppo, fornire la variabile stringa che comprende il nome della
cartella contenente i documenti ordinati.
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Questo è necessario per definire un gruppo di documenti creato dall'utente. Per ulteriori informazioni,
consulta Create a new document group alla pagina 2486.

8. Fai clic su Salva.

Dopo l'esecuzione di TaskBot, la cartella di output può avere fino a quattro sottocartelle:
• Operazione riuscita: contiene documenti da cui il package ha estratto correttamente tutti i campi, e

che vengono visualizzati come file .csv.
• Convalida: contiene documenti che richiedono la convalida.

I documenti appaiono come .csv e IQ Bot estrae i dati prima di convalidarli. Tuttavia, se selezioni
questa opzione, i documenti saranno disponibili in Validator e potrai scaricare l'output convalidato
separatamente.

• Ripetizione: contiene documenti inviati per la convalida.
Questi documenti vengono archiviati nel formato di input originale e puoi prepararli caricandoli
nell'istanza di apprendimento esistente. Il package non crea nuovi gruppi. Per creare nuovi gruppi
e preparare i documenti non riusciti, utilizza l'opzione Carica per inviare i documenti dalla cartella
Output\Ripetizione all'istanza di apprendimento. I gruppi vengono creati in base alla Soglia di
creazione dei gruppi definita nell'istanza di apprendimento.

• Non elaborato: contiene documenti non elaborati a causa di errori nel tempo di esecuzione.
Questi documenti vengono archiviati nel formato di input originale e puoi elaborarli utilizzando il
package IQ Bot Extraction.

Se utilizzi IQ Bot Validator, i file convalidati vengono archiviati nella cartella di output del server IQ Bot.
Use the IQ Bot > Download all documentsIQ Bot: Scarica tutti i documenti per scaricare i file nella
cartella di output sul dispositivo locale.

IQ Bot package
The IQ Bot package enables you to upload and download documents from an IQ Bot server.

Actions nel package IQ Bot

Il package IQ Bot include le seguenti actions:

Action Descrizione

Download all
documents

Consulta Azione Download all documents (Scarica tutti i documenti) alla pagina
1662.

Carica documento Consulta Upload document action alla pagina 1663.

To perform these tasks using APIs, see APIs to upload files, check file status, and downloading CSV file (A-
People login required)

Azione Download all documents (Scarica tutti i documenti)
Utilizza l'action Scarica tutti i documenti per scaricare i risultati estratti da un server IQ Bot creato
eseguendo un Bot con l'action Carica documento.

Nota:  Per eseguire questa operazione utilizzando un'API, vedi Utilizzo di API per caricare file, controllare lo
stato dei file e scaricare file CSV (è richiesto l'accesso ad A-People).
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IQ Bot estrae i campi dai documenti e li esporta come file in formato CSV. Questa action consente anche di
scaricare qualsiasi documento non classificato, non formato e non valido nella directory locale.
Per scaricare i risultati estratti dal server IQ Bot, procedi nel modo seguente:
1. Nella tavolozza Actions fai doppio clic su o trascina l'action Scarica tutti i documenti dal package

IQ Bot.
2. Nel campo Nome dell'istanza di apprendimento seleziona il nome.
3. In Stato documento seleziona lo stato appropriato per i documenti.

• Operazione riuscita: I documenti sono stati elaborati e sono in formato .csv.
• Non valido: I documenti sono stati contrassegnati come non validi durante il processo di

convalida.
• Non classificati: I documenti non potevano essere classificati in alcun gruppo.
• Non formati: I documenti sono stati classificati in nuovi gruppi durante l'elaborazione e richiedono

formazione.
• Esito negativo: I documenti non sono stati elaborati e richiedono una nuova elaborazione. Un

documento riflette lo Stato del documento come Esito negativo se si verifica un'eccezione
durante l'estrazione dei dati, la convalida o la memorizzazione dell'output finale nel database.

I documenti non elaborati nelle cartelle Non validi, Non classificati, Non formati e Esito
negativo sono disponibili nel loro formato originale. Ad esempio, se i documenti di input sono in
formato .pdf, anche l'output nelle cartelle elencate sopra si ottiene nel formato .pdf.

Nota:  After you upload a document by using the Upload action, to retrieve the latest results from
the server, you need to run the Downloadaction periodically. Assicurati di mantenere un ritardo
compreso tra 30 secondi e 1 minuto tra l'esecuzione di due action Scarica IQ Bot consecutive della
stessa natura.

4. In the Local output folder field, provide the path to the file that will hold the output.
5. Nella casella di controllo Elimina file dal server dopo il download seleziona l'opzione per eliminare

i documenti.
Se scegli questa opzione, anche se non riesci a completare il download, è disponibile per un nuovo
download un file .zip contenente i documenti non riusciti. Pertanto, devi selezionare questa opzione.

6. Opzionale: Nel campo Salva la risposta alla variabile aggiungi una variabile. Seleziona ad esempio
prompt-assignment - string dall'elenco a discesa.
Un valore di variabile in questo campo fornisce informazioni sul fatto che il download sia riuscito o
meno e sul motivo dell'errore.

7. Fai clic su Aggiorna.
8. Fai clic su Salva.
9. Fai clic su Esegui ora.
10. Fai clic su Chiudi.

Nota:  Se il download ha esito negativo, verifica il valore della variabile utilizzando un'action Finestra
di messaggio o Registra su file. Vedi la descrizione Salva la risposta alla variabile.

11. Vai alla cartella di output locale per esaminare i file scaricati.

Upload document action
The Upload Document action enables you to upload a document with IQ Bot. IQ Bot extracts fields from
the document and exports them to CSV files.
• Gain access to an Control Room.
• Ensure your local host is a registered device in the Control Room.
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Nota:  To perform these tasks using APIs, see using APIs to upload files, check file status, and download CSV
files (A-People login required).

Use the Upload Document action to upload a single document to the Control Room.

Nota:  Confidential computing di Azure consente alle organizzazioni di caricare i dati crittografati in un
archivio protetto, ad esempio cartelle private su una macchina virtuale. Se si caricano documenti da tali
cartelle protette su IQ Bot, questi vengono portati in stato Non classificato in quanto l'estrazione dei dati
non è supportata per tali documenti.

Follow these steps to upload a document:
1. In the Actions palette, double-click or drag the Upload Document action from the IQ Bot package.

Nota:  A file size of 50 MB is supported for the upload action.

Nota:  The file names of the documents that you upload should not start with special characters, such
as the hyphen (-).

2. Nel campo Nome dell'istanza di apprendimento seleziona il nome.
3. In the File path field, specify the location or type of the file.
4. Opzionale: Nel campo Etichetta del gruppo, fornire la variabile stringa che comprende il nome della

cartella contenente i documenti ordinati.
Questo è necessario per definire un gruppo di documenti creato dall'utente. .

5. Opzionale: In the Save the response to variable field, add a variable. For example: select prompt-
assignment - string from the drop-down list.
A variable value in this field provides information about the file upload process: if the upload was
successful or failed, and the reason for the failure.

6. Fai clic su Applica.
7. Fai clic su Salva.
8. Fai clic su Esegui ora.
9. Fai clic su Chiudi.

To upload multiple files, insert the Upload Document action into a Loop action. See the Loop package
alla pagina 1681.

JavaScript package
The JavaScript package contains actions to run a JavaScript from a bot. These actions can run JavaScript
on Windows, Linux, and UNIX based devices.

Prima di iniziare

1. Open a JavaScript file, or specify the script you want to run using the Open action. You must
associate the details of the file or script you want to run with a session name. Utilizza questo stesso
nome di sessione per altre actions JavaScript.

2. Use the Run JavaScript action to run a function within a script or an entire script. You must use the
same JavaScript session name established in the Open action.

© 2023 Automation Anywhere. All rights reserved.     1664

https://apeople.automationanywhere.com/s/article/IQBOT-API-s-to-UPLOAD-Check-FILE-STATUS-DOWNLOADING-FILE
https://apeople.automationanywhere.com/s/article/IQBOT-API-s-to-UPLOAD-Check-FILE-STATUS-DOWNLOADING-FILE


    Automation Anywhere - Crea

3. Close the JavaScript session after running the script.
To review the bot launcher logs, navigate to C:\ProgramData\AutomationAnywhere
\BotRunner\Logs\<current month>\Bot_Launcher-<today's date>.log.zip. Each
zipped folder contains a file with data on the code execution, which is useful for debugging.

Nota:  Review the following known JavaScript exceptions (other exceptions might exist based on individual
scenarios):
• All JavaScript run with JavaScript actions on the terminal.
• We do not support any JavaScript that requires a browser to run.

Actions nel package JavaScript

Il package JavaScript include le seguenti actions:

Nota:  If you built a bot using actions from the JavaScript package from Build 5322 or earlier, the actions
will be missing when you open the bot with the default package version. You must reinsert the actions and
repopulate the fields.

Action Descrizione

Chiudi Consulta Close action in JavaScript alla pagina 1665.

Apri Consulta Open action in JavaScript alla pagina 1665.

Run JavaScript Consulta Run JavaScript action alla pagina 1666.

Close action in JavaScript
This action enables you to close the session.

Impostazioni

To close the JavaScript, specify the same session name from the Open action.

Open action in JavaScript
You can open a JavaScript file using this action.

Impostazioni

Opens a JavaScript file.
• In the  JavaScript  session field, specify a session name. Use this same session name for other 

JavaScript  actions.
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• Choose one of the following options:
• Nell'opzione Importa file esistente, seleziona un file JavaScript esistente.

Nota:  If you are uploading a script from a file on your desktop, the file and any dependencies must
be in a standalone folder. When you select a file for upload, all files and folders at the same folder
level are uploaded.

• Nell'opzione Input manuale, immetti JavaScript.

Run JavaScript action
This action enables you to run a function within the JavaScript file.

Impostazioni

Runs a function within the JavaScript.
• In the  JavaScript  session field, specify a session name. Utilizza lo stesso nome di sessione

dell'action Apri.
• Facoltativo: Specifica il nome della funzione da eseguire e gli argomenti da passare alla funzione.

Nota:  You can pass only a list variable as an argument for the function. You can use the list variable to
pass multiple arguments of different data types such as Boolean, datetime, number, and string.

• Facoltativo: In the Assign the output to variable field, specify the variable. La  mostra un nome
descrittivo predefinito della variabile. If you create several output variables, subsequent variable names
are appended with a -1, -2, -3, and so on to avoid duplication.

package Json
Estrai le informazioni richieste dal testo o dal file Json utilizzando il package Json e utilizza i valori estratti
nei bots.

Prima di iniziare

Usa le actions nel package Json nel seguente ordine:
1. Inizia la sessione Json utilizzando l'action Inizia sessione. Utilizza questo nome della sessione per

tutti le actions corrispondenti.
2. Utilizza le diverse actions disponibili nel pacchetto Json per automatizzare le attività correlate a Json.
3. Termina la sessione utilizzando l'action Termina sessione per completare un'attività.

Actions nel package Json

Il package Json include le seguenti actions:

Action Descrizione

Termina sessione Consulta End session action in JSON alla pagina
1667.
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Action Descrizione

Ottieni l'elenco dei nodi Consulta Get node list action in JSON alla pagina
1667.

Ottieni il valore del nodo Consulta Get node value action in JSON alla pagina
1667.

Inizia sessione Consulta Start session action in JSON alla pagina
1667.

End session action in JSON
You can close a JSON session using the End session action.

Impostazioni

Chiude una sessione Json.
• Immetti il nome della sessione o seleziona una variabile esistente utilizzata nell'action Inizia sessione.
• Salva e chiudi la sessione.

Get node list action in JSON
This action enables you to retrieve a list of nodes for a node path.

Impostazioni

Recupera l'elenco dei nodi figlio per un percorso del nodo.
• Inserisci la chiave o il percorso del nodo per recuperare più nodi o seleziona una variabile.
• Inserisci il nome della sessione o seleziona una variabile esistente utilizzata nell'action Inizia sessione.
• Nel campo Salva il risultato in una variabile, seleziona una variabile di tipo elenco per mantenere

l'output.

Get node value action in JSON
You can retrieve the node value in JSON.

Impostazioni

Recupera il valore di un nodo.
• Inserisci la chiave o il percorso del nodo per recuperare più nodi o seleziona una variabile esistente.
• Immetti il nome della sessione o seleziona una variabile esistente utilizzata nell'action Inizia sessione.
• Nel campo Salva il risultato in una variabile, seleziona una variabile di tipo stringa per mantenere

l'output.

Start session action in JSON
This action enables you to creates a new JSON session based on a JSON file or specified text.
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Impostazioni

Creates a new JSON session based on a JSON file or specified text.
• Avvia la sessione Json.
• In the Data Source field, select either File or Text:

• File: Seleziona da File della Control Room, File desktop o una Variabile esistente del tipo di
file.

• Testo: specifica il nome del testo o seleziona una variabile.

Nota:  json e .txt sono supportate nel percorso del file per l'opzione Desktop.

• Seleziona una delle seguenti schede dalla sessione dell'oggetto Json per creare una sessione Json:
• Sessione locale: Specifica un nome sessione utilizzabile solo nel bot corrente.
• Sessione globale: Specifica un nome sessione utilizzabile in più bots come bots padre, bots figlio e

altri bots figli dei bots padre.
• Variabile: Specifica una variabile di sessione utilizzabile per condividere quella sessione con altri

bots figlio.

Legacy Automation package
The actions in the Legacy Automation package are only used in migrated bots to ensure that they run
seamlessly in Automation 360. We do not recommend using this package for new bot development.

Nota:  If you built a bot using actions from the Legacy Automation package from Build 5322 or earlier,
the actions will be missing when you open the bot with the default package version. You must reinsert the
actions and repopulate the fields.

Expressions

Expressions appear in action input fields. This package has the following expressions:

Espressione Descrizione Use example

DictionaryToStringConverts a dictionary variable to a
string variable

{{$dictionaryVar.LegacyAutomation:dictionaryToString
$}}

The output is a string variable with the
following value: {key1,value1},
{key2,value2}
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Espressione Descrizione Use example

GetAbsolutePathProvides you the relative path of all
(non-Automation Anywhere) files
present on your system by having a
global variable at the start of the path.
In Enterprise 11 or Enterprise 10,
the equivalent of GetAbsolutePath
is present at Tools > Options >
Runtime Settings > Start in path
of task.
In Enterprise 11 or Enterprise 10,
any folder in the repository can
be used as a starting path for the
GetAbsolutePath value. If the path
in the Enterprise 11 or Enterprise 10
bot is an absolute path, the migration
process does not make any change
to the migrated bot. If the path in
the Enterprise 11 or Enterprise 10
bot is a relative path and contains a
variable, the migration process adds a
global variable at the start of the path
as prefix alongside the relative value
path.

• variable.txt: The input
provided in this example
is a relative path, and the
output will be C:\testing
\variable.txt, where, C:
\testing\variable.txt is a
start-in path.

• \\datashare\variable.txt:
The input provided in this example
is a network path, and the
output will be \\datashare
\variable.txt.

• D:\testing\Automation
 Anywhere Files\Automation
 Anywhere\My Docs
\mydoc.docx: The input
provided in this example is
an absolute path, and the
output will be D:\testing
\Automation Anywhere Files
\Automation Anywhere\My
 Docs\mydoc.docx.

GetBotPath Modifies the value of the bot path
variable in the Enterprise 11 or
Enterprise 10 bots and replaces it
with the relative bot path according
to the Automation 360 repository. The
value of the bot path is based on the
ApplicationPath of the local path
or network path.

• D:\testing\Automation Anywhere
Files\Automation Anywhere\Bots
\My Tasks\test.atmx: The input
provided in this example is an
absolute path, and in this case, the
output path will be My Tasks/
test.

• $AAApplicationPath$\Automation
Anywhere Files \Automation
Anywhere\Bots\My Tasks
\test.atmx: The example provided
in this input is related to
$AAApplicationPath$, and the
output will be My Tasks/test.

• \\Automation Anywhere Files
\Automation Anywhere\Bots\My
Tasks\test.atmx: The example
provided in this input is a network
path, and the output will be My
 Tasks/test.

GetDecrementedNumberDecrements the value of the
respective variable by 1. It is used
mostly in the index positions of list,
record, array or table variables.

$myArray[$Loop-
Counter-1.LegacyAutomation:getDecrementedNumber
$][0]$

The output of myNumber decreases by
1 with each iteration of the loop.
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Espressione Descrizione Use example

GetIncrementedNumberIncrements the value of the respective
variable by 1. It is used mostly in the
index positions of list, record, array or
table variables.

$Loop-
Counter-1.LegacyAutomation:getIncrementedNumber.Number:toString
$The output of myNumber increases
by 1 with each iteration of the loop.

GetKeystrokeCountCalculates the values of keystrokes in
a phrase/text

Nota:  A special character, such as
[TAB], [END], or [PAGE DOWN], is
counted as one keystroke.

$KeyStroke-
CharLength.LegacyAutomation:getKeystrokeCount.String:toNumber
$

The output is the average delay for
each keystroke.

GetLegacyIndexValueRetrieves the value from the specific
index position of the list variable in
the bots migrated from Enterprise 11
or Enterprise 10. If the index position
is greater than the size of the list
variable, the system retrieves the
value from the first index position of
the list in the migrated bots

ListToString Converts a list variable to a string
variable.

{{$listVar.LegacyAutomation:listToString
$}}

The output is a string variable
with the following value:
value1,value2,value3

ListToTable Converts a list variable to a table
variable.

{{$my-list-
variable.LegacyAutomation:listToTable
$}}

The output is a table variable where
each list value is cell in a single
column.

ParseLegacyKeysEnsures that the Insert Key
Stroke command of the Enterprise
10/Enterprise 11 bots stored in
variables is successful upon execution.
This expression converts them into
equivalent Automation 360 key strokes
during the execution.

Nota:  The appearance of some
special characters differs between
Version 11.3 and Automation 360. For
example, the Page Up key appears as
[PAGE UP] in Version 11.3 and [PAGE-
UP] in Automation 360. This difference
does not impact bot function.

$Test.LegacyAutomation:parseLegacyKeys
$
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Espressione Descrizione Use example

ParseVariableOperationParses the expression provided in
the Enterprise 10/Enterprise 11
Variable Operation command. This
expression ensures that Automation
360 returns the same output as
Enterprise 10/Enterprise 11 bots upon
execution.

$prompt-
assignment.LegacyAutomation:parseVariableOperation
$

TableToString Converts a table variable to a string
variable.
You can also use delimiters such as a
colon, semicolon, or space to separate
the values of the string variable in the
output.

{{$tableVar.LegacyAutomation:tableToString
$}}

The output is a string variable with the
following value: {value1,value2},
{value3,value4}

Use a colon, semicolon, or space as
<"delimiter">:
{{$tableVar.LegacyAutomation:tableToString(<"delimiter">)$}}
For example:

{{$tableVar.LegacyAutomation:tableToString(":")$}}

The output is a string variable with the
following value: {value1:value2}:
{value3:value4}

TableToList Converts a table variable to a list
variable.

{{$DataTable.LegacyAutomation:tableToList(<column_index>)$}}
 For example:
 {{$DataTable.LegacyAutomation:tableToList(2)$}}

The output is a list variable
with the following value:
[value1,value2,value3]

StringToList Converts a string type variable to a list
type variable

$SampleString.LegacyAutomation:stringToList
$

The output is a list variable of size 1
with value same as "SampleString"

StringToTable Converts a string type variable to a
data table type variable

$SampleString.LegacyAutomation:stringToTable
$

The output is a data table variable
with size (1*1) and value at index
[0,0] same as SampleString

Utilizzo di azioni web legacy
In Automation 360, è stata eseguita la migrazione di tutti i comandi (eccetto Trova link interrotti e Scarica
file) del registratore web nelle loro rispettive actions all'interno di Legacy Automation package. Non
consigliamo di utilizzare Legacy Automation package per lo sviluppo di nuovi bot.
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actions web in Legacy Automation package

Il package Legacy Automation include le seguenti actions:

Azione Descrizione

Chiudi pagina Chiude la sessione del browser per una finestra o scheda aperta.

Aggiorna titolo della
finestra

Aggiorna il titolo della finestra durante la migrazione dei bots, da
Internet Explorer a Microsoft Edge con la modalità IE. All'esecuzione
di questa action, il titolo della finestra viene modificato nel formato
*Microsoft*Edge. Questa action viene utilizzato solo quando il titolo
della finestra è determinato da una variabile e non quando il titolo della
finestra è statico. Il titolo della finestra viene aggiornato quando il bot
viene eseguito e non durante il processo di conversione.
• Nel campo Finestra, seleziona un'opzione: Scegli dalla scheda

Applicazione, Browser o Variabile.
• Applicazione: seleziona da un elenco di finestre, incluse le finestre

del browser, attualmente aperte sul dispositivo Bot Creator.
• Browser: seleziona da un elenco di schede del browser supportato.
• Variabile: seleziona una variabile finestra esistente per specificare il

titolo del titolo della finestra dell'applicazione.

Nota:  Sebbene il pannello delle proprietà contenga l'opzione Browser
e Applicazione, durante la migrazione viene utilizzata solo l'opzione
Variabile.

• Seleziona un'opzione per specificare se il titolo della finestra è
un'espressione regolare o meno.

• Quando questa action viene eseguita, il campo Nuovo titolo della
finestra visualizza il titolo della finestra modificato (Microsoft Edge in
modalità IE).

Esegui funzione
JavaScript

Esegue internamente il codice JavaScript su una pagina web in Internet
Explorer o Microsoft Edge (modalità IE).
Puoi eseguire JavaScript all'interno di una pagina web fornendo JavaScript
come input di azione. Quando esegui una funzione JavaScript, puoi vedere
e modificare le proprietà dell'iFrame selezionato.
• Specifica l'URL.
• Specifica il nome della funzione da eseguire e gli argomenti da passare

alla funzione.
• Specifica la variabile in Assegna l'output al campo variabile

(facoltativo).
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Azione Descrizione

Estrai dati Estrae i dati da un URL specificato in Internet Explorer o Microsoft Edge
(modalità IE).
• Specifica l'URL del sito web per estrarre i dati da una pagina web.
• Inserisci il tipo di controllo e il valore del controllo.
• Se desideri riutilizzare una scheda o una finestra esistente,

contrassegna le caselle di controllo e specifica le proprietà Titolo
pagina o URL pagina nell'action.

• Specifica il tempo in secondi in Attendi che il controllo esista. Il
tempo predefinito è 30 secondi.

• Nel campo Salva il risultato in una variabile, seleziona Variabili
multiple o Dizionario:
• Variabili multiple: fai clic su Aggiungi mappatura variabili per

associare ogni chiave del dizionario a una variabile nel bot padre.
Usa questa opzione se non vuoi utilizzare actions per estrarre i valori
del dizionario.

• Dizionario: inserisci o crea una variabile del dizionario per
contenere le variabili e i valori di output in coppie chiave-valore.

Estrai dati modello Estrae i dati basati sul modello da una pagina di Internet Explorer. Utilizza
l'estrazione dei dati basata su modelli se le voci Web seguono un modello.
Questa funzionalità riconosce il modello ed estrae i dati, anche se si
estendono su più pagine. I dati estratti vengono salvati in un file CSV.
• Per estrarre i dati basati sui modelli, inserisci l'URL del sito web e il

titolo della pagina.
Puoi visualizzare in anteprima i dati acquisiti estratti e il loro valore.

• Specifica il percorso del file CSV in cui scrivere i dati.
• Seleziona un'opzione per specificare cosa fare quando si scrivono dati in

un file:
• Aggiungi al file
• Sovrascrivi il file

• Seleziona un'opzione nell'elenco di codifica per specificare la codifica
che desideri applicare al file. La codifica predefinita è impostata su
ANSI.
• ANSI
• UTF-8
• Unicode

Estrai sorgente Estrae l'origine di un elemento in una pagina web specificata e assegna il
valore a una variabile.
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Azione Descrizione

Estrai tabella Estrae la tabella da un URL specificato e, facoltativamente, la salva in un
nuovo file CSV o la aggiunge a un file CSV esistente.
• Specifica l'URL per aprire una pagina web in una finestra Internet

Explorer.
• Specifica il numero tabella per estrarre i dati della tabella.
• Specifica il percorso del file CSV in cui scrivere i dati.
• Seleziona l'opzione Aggiungi a un file csv già esistente quando

scrivi i dati in un file esistente.
• Seleziona un'opzione nell'elenco di codifica per specificare la codifica

che desideri applicare al file. La codifica predefinita è impostata su
ANSI.
• ANSI
• UTF-8
• Unicode

• Specifica il tempo in secondi in Attendi che il controllo esista. Il
tempo predefinito è 30 secondi.

• Inserisci il nome della sessione nel campo Nome sessione.
• Se desideri riutilizzare una scheda o una finestra esistente,

contrassegna le caselle di controllo e specifica le proprietà Titolo
pagina o URL pagina nell'azione.

• Fornisci i dettagli dei tag (Nome tag e Nome attributo) dei dati della
tabella estratta e salva il risultato in un file CSV o assegna l'output a
una variabile della tabella dati.

Vai indietro Torna alla pagina precedente.

Gestisci controlli Web Identifica le proprietà di un controllo dell'interfaccia utente da un sito web
specificato.
• Seleziona l'opzione per aprire un nuovo URL oppure Seleziona

pagina.
• Puoi fornire i criteri di ricerca dell'oggetto acquisito. Cerca l'oggetto

specificando Nome controllo, Valore o Indice.
• Se desideri riutilizzare una scheda o una finestra esistente,

contrassegna le caselle di controllo e specifica le proprietà Titolo
pagina o URL pagina nell'action.

• Seleziona il tipo di controllo dal menu a discesa.
• Specifica il tempo in secondi in Attendi che il controllo esista. Il

tempo predefinito è 30 secondi.
• Scegli una variabile per assegnare un output a una variabile.

Passa alla pagina Apre una pagina web in una finestra di Internet Explorer esistente.
• Specifica l'URL nel campo Passa all'URL per aprire una nuova finestra

con l'URL specificato.
• Se desideri sovrascrivere una scheda o una finestra esistente,

contrassegna le caselle di controllo e specifica le proprietà Titolo
pagina o URL pagina nell'azione.
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Azione Descrizione

Apri pagina Apre una pagina web in Internet Explorer in un URL specificato.
• Specifica l'URL per aprire una pagina web in una finestra Internet

Explorer.
• Se desideri riutilizzare una scheda o una finestra esistente,

contrassegna le caselle di controllo e specifica le proprietà Titolo
pagina o URL pagina nell'azione.

Didascalia di Cerca per Cerca nella prima finestra di Internet Explorer aperta la didascalia e la
frequenza di occorrenza specificate. Puoi aggiornare il campo Didascalia
e Occorrenza nel bot.

Configura impostazioni Imposta l'opzione di configurazione per l'actions web. Puoi selezionare una
delle seguenti opzioni o tutte le opzioni:
Quando configuri questa action con le seguenti impostazioni, le
impostazioni configurate verranno applicate a tutte le actions sotto il
gruppo web.
• Lancia Internet Explorer come processo.
• Apri un browser in background.
• Avvia Internet Explorer in modalità di compatibilità Edge.

Nota:  Quando selezioni l'opzione Avvia Internet Explorer in
modalità di compatibilità Edge tutte le automazioni create in
precedenza su Internet Explorer 11 utilizzando l'actions web verranno
eseguite e funzioneranno in Microsoft Edge con la modalità IE. Le
actions all'interno del gruppo web vengono eseguite senza problemi in
Microsoft Edge in modalità IE.

List package
The List package contains actions that enable you to perform various operations on a variable of the list
data type.

Working with variables of list data type

A list is a collection of ordered values. The values can be of Boolean, number, or string data subtype.
When initializing a list variable, you can select the Any data subtype in order to hold any of the three data
subtypes. You can manually enter values by creating a new variable or selecting an existing one from the
Variables menu, and then clicking Add.
Common uses of list variables include:
• Sending an email to multiple recipients.
• Searching multiple web addresses.

Actions in the List package

If you are using a List action in a Loop action, you must use the For each item in the list iterator.
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The following actions are available in the List package:

Action Descrizione

Add item Consulta Add item action in List alla pagina 1677.

Append Consulta Append action in List alla pagina 1677.

Assegna Consulta Assign action in List alla pagina 1678.

Clear Consulta Clear action in List alla pagina 1678.

Get item Consulta Get item action in List alla pagina 1678.

Join items Consulta Join items action in List alla pagina 1679.

Remove item Consulta Remove item action in List alla pagina 1679.

Set item Consulta Set item action in List alla pagina 1679.

Dimensione Consulta Size action in List alla pagina 1679.

Esempio

Create a bot to add items to a list and retrieve data from a list. To achieve this functionality, perform the
following steps:
1. Create a bot.

a. Nel pannello di sinistra, fai clic su Automazione.
Viene visualizzato un elenco dei moduli e dei bots disponibili.

b. Fai clic su Crea un bot.
c. Inserisci il nome del bot: ListBot
d. Fai clic su Crea e Modifica.

2. Create the following variables.
• Variable: StringList

• Tipo: Elenco
• Subtype: Stringa
• Name: StringList
• Default value at 0: Automation
• Default value at 1: Anywhere

• Variable: SampleString

• Name: SampleString
• Default value: PvtLtd

• Variable: ListOutput

• Tipo: Qualsiasi
• Name : ListOutput
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3. To insert an item into a list variable, from the Actions pane, double-click or drag the List > Add item
action.
a. In the List variable field, select StringList.
b. In the Items to be added field, select SampleString.
c. To insert the item at the end of the list, select the To end of list option.

4. To retrieve a value at a specified position in a list, from the Actions pane, double-click or drag the List
> Get item action.
a. In the List variable field, select StringList.
b. In the Index number field, enter 0. This is to specify the position in the list from where you

want to retrieve a value.
c. To store the output from Assign the output to variable list, select ListOutput.

5. To print the value of the Index 0, double-click or drag the Message box action. Click Save and Run.
The bot displays the zero index data of the list variable, which is Automation.

Riferimenti correlati
Loop package alla pagina 1681
Utilizza il Loop Pacchetto per eseguire una sequenza di actions ripetutamente per un numero specifico di
volte o fin quando una condizione specifica non sarà soddisfatta.
Variables overview alla pagina 2022
Automation 360 offers a variety of variables, each designed to hold specific types of data and is intended
for specific use. Use the topics below to learn more about each variable and how to use them.

Add item action in List
The Add item action enables you to insert an item into a list variable.

Impostazioni

You can choose to add the item at the end of the list or specify a position in the list.
• Select the list variable in which to add an item from the List variable list.
• Select the variable that contains the value to add from the Item to be added list.

Nota:  The variable must be of the same sub-data type as the other list items.

• Select the To end of list option to insert the item at the end of the list or select At list index to
specify the index in the list where to insert the item.
The list index starts from 0. The first item in the list is at position 0, the second item at 1, and so on.
For example, to add an item at the fourth position in a list, enter 3 in the At list index field.

Append action in List
The Appendaction enables you to add a list variable into the column index of a data table.
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Impostazioni

You can choose to add the list variable at the start or end, or specify a position in the data table.
• Select the list variable that contains the value to be added.
• In the Assign the outcome to Data Table field, select a table variable that you want to use to store

the output.
• Choose from the following options to insert a column at index:

• First index: Sets the value to the first position (0 index) in a data table.
• Last index: Sets the value at the end of the data table.
• Specific index: Specify the index where you want to enter the column index. Ad esempio, per

impostare un valore per la prima colonna, inserisci 0.
The index number starts from 0. The first item in the data table is at position 0, the second item
at 1, and so on. For example, to add an item at the third position in a data table, enter 2 in the
Specific index field.

Assign action in List
The Assign action enables you to assign the value of the source list to the destination list variable.

Impostazioni

• On the List tab, select the source list variable from the drop-down list and specify a value in the Value
at 0 field or create a new list variable.

• On the Variable tab, insert a value for the list variable.
• Select a destination list variable or create one to hold the output.

Clear action in List
Use the Clear action to clear all items from the selected list variable.

Impostazioni

Select the list variable from which you want to clear the items.

Get item action in List
You can retrieve a value at the specified position in a list and store the output to a variable using the Get
item action.

Impostazioni

• Select the list variable from which you want to retrieve a value from the List variable list.
• Specify the position in the list from where you want to retrieve the value in the Index number field.

The list index starts from 0. The first item in the list is at position 0, the second item at 1, and so on.
• Select a variable that you want to use to store the output from the Assign the output to variable

list.

© 2023 Automation Anywhere. All rights reserved.     1678



    Automation Anywhere - Crea

Join items action in List
The Join items action enables you to combine all the available values in a list variable and store the
output to a string variable.

Impostazioni

Combines all the available values in a list variable and stores the output to a string variable. You can
specify the delimiter you want to use as a separator in the output.
• Select the list variable that you want to use from the List variable list.
• Specify the delimiter you want to use to separate values in the output in the Delimiter field.
• Select a variable that you want to use to store the output from the Assign the output to variable

list.

Remove item action in List
The Remove item action enables you to remove an item from a list and assign the output to a variable.

Impostazioni

• Select the list variable from which you want to remove an item from the List variable list.
• Specify the position in the list from where you want to remove the value in the Index number field.

The list index starts from 0. The first item in the list is at position 0, the second item at 1, and so on.
• Select a variable that you want to use to store the output from the Assign the output to variable

list.

Set item action in List
You can set an item at the specific position in a list and store the output in a variable using the Set item
action.

Impostazioni

• Select the list variable in which you want to set a value from the List variable list.
• Specify the position in the list where you want to set the item in the Index number field. The list

index starts from 0. The first item in the list is at position 0, the second item at 1, and so on.
• Select a variable from the drop-down list in the Replace with field to replace the list variable.
• Select a variable that you want to use to store the output from the Assign the output to variable

list.

Size action in List
The Size action enables you to retrieve the number of items in a list and assign the output to a number
variable.

Impostazioni

• Select the list variable for which you want to retrieve the size from the List variable list.
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• Select a number variable that you want to use to store the output from the Assigns the number of
items to variable list.

Log To File package
Use the Log To File package to create a log file with data.
The Log To File package enables the following:
• Verify that a bot ran properly.
• Create a new log file.
• Specify custom text to be included in the log file.
• Add a time stamp to the log file.
• Use a log file as a variable.

Nota:  The package supports ANSI, Unicode, and UTF8. It can save files as .csv and .txt.

Actions nel package Log To File

Il package Log To File include le seguenti action:

Action Descrizione

Registra nel file Consulta Using Log to file action alla pagina 1680.

Using Log to file action
The Log to file action in the Log To File package enables you to create a log file with data about the
events that occur when a TaskBot runs.
Follow these steps to log text into a file:
1. In the Actions palette, double-click or drag the Log to file action from the Log To File package.
2. In the File path field, specify the file location or variable.
3. In the Enter text to log field, enter the text to log in the file.
4. Select the Append timestamp check box to add a time stamp.
5. In the When logging field, choose Append to existing log file to append the log file or

Overwrite existing log file to overwrite the content in the log file.
6. Select the Encoding type.

• ANSI: Used to encode Latin alphabet.
• UNICODE
• UTF8: Can encode all possible characters.
• UTF-16LE: Inserts a byte order mark (BOM) Unicode character at the beginning of the file.

Nota:  Shift-JIS files must use ANSI as encoding to read text file content.

If you selected the Append to existing log file option in Step 5, ensure that the selected encoding
type matches that of the original file, otherwise some of the characters might not be logged.

7. Fai clic su Salva.
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Loop package
Utilizza il Loop Pacchetto per eseguire una sequenza di actions ripetutamente per un numero specifico di
volte o fin quando una condizione specifica non sarà soddisfatta.
The Loop package enables you to repeatedly run specific actions within a bot. For example, repeat the
set of actions that read data from each row of a Microsoft Excel file, rename all files in a folder, and save
each email in a mailbox. Puoi anche utilizzare l'action If all'interno del Loop Azione per convalidare una
condizione e, in base al risultato, saltare l'iterazione corrente nel ciclo o addirittura interrompere il ciclo.
For conditional loops, different actions are taken depending on whether the conditional parameters are
met. For loops that have a specified number of iterations, the loop exits on the last iteration and goes to
the next step in the bot.
When you run a sequence of actions repeatedly for a specific number of times within a loop, the end
condition within the loop is evaluated in every iteration.
For example, when you loop through a Data Table that has 10 columns, enter dynamic values of column
count for the end condition in the loop, use the Data Table > Delete column action to delete the
column of index 0 inside the loop body, and then run the bot, the bot deletes a column in every iteration.
Hence it reduces the iteration count because the loop end condition is evaluated in each iteration.

Actions nel package Loop

The following Loop actions are available:

Azione Descrizione

Loop Consulta Utilizzo dell'action Loop alla pagina 1688.

Continua Consulta Continue action alla pagina 1688.
Consulta If package alla pagina 1625.

Interrompi Consulta Break action alla pagina 1688.
Consulta If package alla pagina 1625.

Condizioni correlate all'iterazione all'interno del Loop Azione

Seleziona l'opzione Iteratore per specificare il numero di volte in cui il set di actions verrà ripetuto
nell'ambito del Loop action:

Iteratore Descrizione

For each row in CSV/
TXT

Repeats the set of actions for each row in the specified CSV or text file and
assigns the values in the current row to a record variable. Consulta Using
the For each row in CSV/TXT iterator alla pagina 1689.

For each row in Data
Table

Repeats the set of actions for each row in the specified table and assigns
the values in the current row to a record variable. Consulta Using the For
each row in table iterator alla pagina 1689.

Per ogni riga di un set
di dati della query SQL

Repeats the set of actions for each row in the specified SQL query dataset
and assigns the values in the current row to a record variable. Provide
the session name that you have used to establish a connection with the
database.
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Iteratore Descrizione

For each key in the
Dictionary

Repeats the set of actions for each key in the specified Dictionary variable
and assigns the name of the current key to a variable.

Nota:  Quando un bot esegue un'action Loop che contiene un'action
Dizionario > Metti, il bot esegue un'iterazione solo sul numero originale
di elementi in un dizionario; ignorando gli elementi inseriti utilizzando
l'action Metti.

For each value in the
Dictionary

Repeats the set of actions for each value in the specified Dictionary
variable and assigns the current value to a variable. Poiché questo tipo di
variabile può contenere vari sottotipi (stringa, numero, operatore booleano
e così via), se crei rapidamente una variabile durante la configurazione
dell'action, la variabile sarà di tipo Qualsiasi.

Nota:  Quando un bot esegue un'action Loop che contiene un'action
Dizionario > Metti, il bot esegue un'iterazione solo sul numero originale
di elementi in un dizionario; ignorando gli elementi inseriti utilizzando
l'action Metti.

For each mail in
mailbox

Repeats the set of actions for each email in the specified mailbox. Consulta
Using the For each mail in mail box iterator alla pagina 1517.

For each row in
worksheet (Excel basic
or Excel advanced)

Repeats the set of actions for each row that contains data in a worksheet
and assigns the values in the current row to a record variable. Provide
the session name that you have used to open the Excel basic or Excel
advanced worksheet. Specify whether to repeat the actions for all the
rows, specified rows, or a specified cell range. Seleziona una variabile
record dall'elenco Assegna la riga corrente a questa variabile o
creane una nuova. Consulta Variabile record alla pagina 2035.
This iterator retrieves cell values as string data types. It supports Excel cell
formats, including Number, Percentage, Currency, Scientific, and Date. For
example, a value from a cell of Currency formatting retains the currency
symbol when passed to a table or record variable.
• You must convert the values to perform non-string operations.
• In Excel advanced, quando scegli come iteratore del loop Per ogni

riga nel foglio di calcolo, è disponibile un'opzione Leggi per leggere
il testo visibile o il valore della cella.
Ad esempio, se la cella ha il 70% come contenuto di cella, l'opzione
Leggi valore cella leggerà il valore come 70 ignorando il formato %,
mentre l'opzione Leggi testo visibile leggerà il contenuto come 70%.

Recommendation:  Utilizza l'opzione Leggi valore cella poiché la
lettura di un valore da una cella offre prestazioni migliori rispetto alla
lettura del testo visibile.

L'utilizzo dell'opzione Sessione globale per condividere una sessione di
Microsoft Excel utilizzando il package Excel advanced non è disponibile con
questa opzione.
Soluzione alternativa: Utilizza l'action Ottieni più celle e salva i dati
in una variabile tabella dati e poi utilizza il package Loop con l'opzione
Tabella dati selezionata.
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Iteratore Descrizione

Per ogni file nella
cartella

Repeats the set of actions for each file in the specified folder and assigns
the properties of the current file to a Dictionary variable containing two
keys: the name key holds the file name and the extension key holds the
file extension.
Per aprire file con estensioni diverse, utilizza l'opzione variabile per
assegnare il percorso della cartella, il nome del file e l'estensione del file.
First, create a variable for the folder path, $sFolder$. Then, for the
files in the folder path, create two variables, one for file name $name$
and another for file extension $extension$. To open a file, combine
the variables as a string, such as $sFolder$\$name$.$extension
$. Affinché l'estensione funzioni con diversi tipi di file e diverse opzioni di
apertura, è possibile aggiungere una logica condizionale.

Per ogni cartella nella
cartella

Repeats the set of actions for each folder in the specified folder and
assigns the current folder name to a String variable.

Per ogni elemento
nell’elenco

Repeats the set of actions for each item in the specified list and assigns
the current item to a variable. Specify whether to repeat the action
for all items in the list or only for the range of items in the list. Poiché
questo tipo di variabile può contenere vari sottotipi (stringa, numero,
operatore booleano e così via), se crei rapidamente una variabile durante
la configurazione dell'action, la variabile sarà di tipo Qualsiasi.

Nota:  The index in a list starts from zero. Ad esempio, per ripetere
l'action per gli elementi dalla terza alla sesta posizione dell'elenco, specifica
2 e 5 nei campi appropriati.

Per n volte Repeats the actions in the container the specified number of times. You
can assign the iteration count to a Number variable.

Per ogni valore nel
record

Ripete le actions per ciascun valore nel record specificato e assegna
il valore corrente a una variabile. . Poiché questo tipo di variabile può
contenere vari sottotipi (stringa, numero, operatore booleano e così via),
se crei rapidamente una variabile durante la configurazione dell'action, la
variabile sarà di tipo Qualsiasi..

Per ogni riunione nel
calendario

Use this option to repeat the set of actions for each meeting in the
specified calendar. Consulta Using Office 365 Calendar actions in a loop alla
pagina 1709.

For each row in
worksheet (Office 365
Excel)

Repeats the set of actions for each row that contains data in a worksheet.
• Provide the session name that you have used to open the worksheet.
• Specify whether to repeat the actions for all the rows or specific rows.
• You can assign the values in the current row to a record variable.

For each node in a
XML dataset

Repeats the set of actions for each node in an XML dataset and assigns
the current node to String variable. Provide the session name that you
have used to open the XML file.

Condizioni correlate a While nel Loop Azione

You can configure multiple while related conditions within a single Loop action:
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1. Fai clic su Aggiungi condizione.
2. Select either of the following options:

• And: Both of the conditions must be met for the actions to run.
• Or: Either of the conditions must be met for the actions to run.

3. Select the conditions from the drop-down list.

Seleziona l'opzione While per utilizzare le seguenti condizioni:

While Descrizione

Applicazione Use the Application is running or Application is not running
condition to run actions based on whether an application is running or not
running.
Enter the application path or specify the path using a variable along with
the amount of time to wait (in seconds) for the condition to be true.

Nota:  The Application is running and Application is not running
conditions are not applicable for Internet Explorer bots because its
corresponding process iexplore.exe runs in the background when
Microsoft Edge is launched in IE mode.

Boolean Use this condition to execute actions based on the value of a Boolean
variable. Use this condition to compare the values of two Boolean variables
or one Boolean variable to a selected Boolean value.

Data table Utilizza la condizione La tabella dati è vuota per eseguire actions in
base al fatto che la tabella specificata contenga valori.
Use the Number of rows and Number of columns conditions to
execute actions based on whether the number of columns or rows is
Equal to, Greater than, or Less than the specified value.

Data e ora Utilizza la condizione Variabile Data e ora per eseguire actions in base
al fatto che il valore della variabile data e ora di origine sia Uguale a o
Non uguale a, Maggiore di o Uguale a oppure Minore di o Uguale a
il valore della variabile data e ora di destinazione.

Dictionary Use this condition to repeat the set of actions based on whether the
selected dictionary variable contains the specified key.

Nota:  The key comparison is case-sensitive.
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While Descrizione

File Use the following conditions to execute the action:
• Data del file

Use this condition to verify the date and time when a file was created
or modified. Specify a date or date range using the On a date, Is
within last, Is between, or Is before options. For the On a date
option, specify a date to verify whether the file was created or modified
on that date. For the Is within last option, specify the number of days
or time (in hours, minutes, and seconds). Enter the amount of time (in
seconds) to wait for this condition to be true.

• Il file esiste e Il file non esiste
Use these conditions to execute an action based on whether a file
exists. For example, if a data file exists, format the file and upload it to
a database.

• File extension
Use this condition to check the file extension of a selected file and then
execute actions based on the results. Use the File path field to select a
file.

• Dimensione del file
This condition verifies if the specified file is larger, smaller, not the
same, or the same as the size you specify.
Enter the amount of time (in seconds) to wait for this condition to be
true.

Folder does or does
not exists

Use these conditions to repeat the set of actions based on whether a
folder exists.

Riconoscimento delle
immagini

Use these conditions to verify whether:
• Il File immagine si trova in File immagine oppure non.
• Image file is found in the Window or not.
• Window is found in the Image file or not.
• Window is found in the Window or not.

For the Window conditions, you can use the Resize window option to
specify the window dimensions. This option delivers a more reliable bot.
It resizes the window to the dimensions at which the task was recorded,
which enhances the bot's ability to identify the target object.

Nota:  This option is only available for windows that can be resized. It is
not available for Desktop or Taskbar options.

Per le condizioni Finestra, è possibile utilizzare l'opzione Anteprima per
selezionare una specifica occorrenza acquisita e posizionare il clic rispetto
all'immagine.

JavaScript Utilizza la condizione Script completato o Script non completato per
l'esecuzione di actions in base allo stato del JavaScript specificato. Select
the file that contains the script and optionally specify the parameters by
selecting a list variable.
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While Descrizione

Automazione legacy Le condizioni di Automazione legacy vengono utilizzate solo in bots
migrati per garantire che vengano eseguiti senza problemi in Automation
360. Non consigliamo di utilizzare queste condizioni per lo sviluppo di
nuovi bot. The following conditions to verify the following:
• Se Controllo Web esiste o meno.
• Se Controllo finestra esiste o meno.
• Se Controllo finestra è attivo o meno.
• Se lo Script è completato o meno.
• Se la Finestra figlio esiste o meno.

For the Window control conditions, you can use the Resize window
option to specify the window dimensions. This option delivers a more
reliable bot. It resizes the window to the dimensions at which the task was
recorded, which enhances the bot's ability to identify the target object.

Elenco Utilizza la condizione Variabile elenco per eseguire actions in base al
fatto che una variabile elenco contenga un determinato valore. Il valore
può essere del tipo dati Numero, Stringa o Operatore booleano.

Numero Utilizza la condizione Variabile numero per eseguire actions in base al
fatto che la variabile numero specificata sia Uguale a o Non uguale a o
Maggiore di o Uguale a o Minore di o Uguale a un particolare valore.

Ping Utilizza la condizione Il ping è riuscito o Il ping non è riuscito per
verificare se la macchina o il server sono in esecuzione ed eseguono action
in base al risultato. Enter the amount of time (in seconds) to wait for the
condition to be true.

Registratore • Utilizza la condizione L'oggetto esiste per rilevare un oggetto in una
finestra. Select a window or variable to capture the object. Inserisci la
quantità di tempo (in secondi) da attendere affinché questa condizione
risulti vera, cioè che l'oggetto venga rilevato.

• Utilizza la condizione L'oggetto non esiste per verificare se un
oggetto specifico esiste in una finestra e poi, in base al risultato,
eseguire le actions. Enter the amount of time (in seconds) to wait for
this condition to be true. Per esempio, è possibile utilizzare l'opzione
L'oggetto non esiste all'interno della condizione Loop > While per
essere sicuri che il bot non esegua l'action successiva se non dopo che
l'oggetto dell'applicazione business aziendale sia stato caricato.

Nota:  The Object exists and Object does not exist Recorder
conditions support Chromium-based Microsoft Edge with Internet Explorer
mode.

Servizio Utilizza la condizione Il servizio è in esecuzione o Il servizio non è
in esecuzione per eseguire actions in base al fatto che un servizio sia in
esecuzione o meno. Seleziona Elenco dei servizi per scegliere un servizio
dall'elenco dei servizi disponibili.
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While Descrizione

String Use the String variable condition to execute actions based on whether
the specified source string value is Equal to or Not equal to, or
Includes or Does not include the target value.
È possibile selezionare l'opzione Caso di corrispondenza per eseguire
actions soltanto se le due stringhe hanno lettere maiuscole e minuscole
corrispondenti.
When you extract text from a Microsoft application, the extracted text
contains the /r/n special characters which indicate a new line. Select
the Ignore Carriage return option if you want to ignore the /r special
character when you compare the text.
Per creare una condizione in base al fatto che una stringa sia vuota o
meno, confronta il valore sorgente con un campo di destinazione vuoto
utilizzando l'operatore Uguale a.
Consulta Example of using a conditional statement alla pagina 2058.

Task Bot Utilizza la condizione Attività completata o Attività non completata
per l'esecuzione di actions in base allo stato di Task Bot.

VBScript Usa la condizione Script completato o Script non completato per
l'esecuzione di actions in base allo stato dello script Visual Basic. Select
the file that contains the script and optionally specify the parameters by
selecting a variable.

Finestra Utilizza la condizione La finestra esiste o La finestra non esiste per
verificare se una specifica finestra dell'applicazione è aperta immettendo
il Titolo della finestra o utilizzando una variabile. Enter the amount of
time (in seconds) to wait for the condition to be true. These conditions are
used when the window title remains constant and to verify if the specific
window is open and execute further actions based on the output.
Utilizza la condizione La finestra con lo stesso titolo non esiste o
Esiste una finestra con lo stesso titolo per verificare se esiste una
finestra con lo stesso titolo o se il titolo della finestra è cambiato. Immetti
il tempo (in secondi) per cui continuare a verificare se la condizione è
vera. These conditions are used for window titles that are dynamic. For
example, when you open a Google account webpage, enter your username
and password to log into your account, the window title changes. If
you want to compose a new email as a next action, you can use these
conditions before you execute the next action to verify if the window with
the same title exists or if the title has changed.

Attività correlate
Example of transferring data from CSV file to Excel worksheet alla pagina 2063
In this example, you build a bot to update the product inventory in an Excel worksheet with new product
names from a CSV file. Use actions from the CSV/TXT, Excel advanced, IF/ELSE, and Loop packages.
Example of entering data into a web form from a worksheet alla pagina 2054
In this example, you build a bot to enter multiple rows of data from an XLSX sheet into a web form. Use
actions from the Excel advanced, Loop, and Recorder packages.
Riferimenti correlati
Variabile record alla pagina 2035
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A record variable holds a row of data extracted from a database, spreadsheet, or table in name-field pairs.
The fields can store values of Boolean, datetime, number, or string data type.
Informazioni correlate
Using loops to control a bot

Continue action
The Continue action in the Loop package enables you to continue the loop in your operation.

Impostazioni

Utilizza l'action Continua insieme all'action If per saltare l'iterazione corrente e continuare con l'iterazione
successiva nel ciclo in base alla condizione specificata nell'action If.

Break action
The Break action in the Loop package enables you to terminate the loop in your operation.

Impostazioni

Use the Break action along with the If action to terminate the loop based on the condition you have
specified in the If action. Quando il ciclo viene terminato, vengono eseguite le action immediatamente
successive all'action Loop.

Utilizzo dell'action Loop
Use the Loop action to repeatedly run a sequence of actions for a specific number of times or until a
condition is met.
To repeatedly run a sequence of actions, do the following:
1. Double-click or drag the Loop action from the Actions palette.
2. Set the desired conditions for the loop.

Opzione Action

Select the Iterator option to repeat the
sequence of actions for a specific number
of times.

Select an option from the Iterator list to specify
how many times the sequence of actions is to be
repeated.
See Loop package alla pagina 1681 for the list of
available options.

Select the While option to repeat the
sequence of actions until a condition is
met.

a. Select an option from the Condition list to
specify the condition.

b. Select the Check the condition at the
end of the iteration to validate the
condition at the end of each iteration. This
option enables you to ensure that the set
of actions run at least one time, even if the
condition is not met.

3. Double-click or drag the actions to be repeated within the Loop.
4. Opzionale: Double-click or drag the Continue action from the Loop package to skip the current

iteration and continue with the next iteration of the loop.
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5. Fai clic su Salva.

Using the For each row in CSV/TXT iterator
Use the For each row in CSV/TXT iterator in the Loop action to read the data of each row in a CSV or
text file and assign the current row to a record variable. The bot reads the values in each cell as string-
type values, even if there are numerical values.
First, open the CSV or text file. Utilizzo dell'action Apri per file CSV/TXT alla pagina 1437

Nota:  The For each row in CSV/TXT iterator only supports CSV/TXT files that conform to the RFC 4180
standard. For more information about the standard, see Common format and MIME type for CSV files.

To use the For each row in CSV/TXT iterator in a Loop action, do the following:
1. Fai doppio clic o trascina l'action Loop dal package Loop nella tavolozza Actions.
2. Select the For each row in CSV/TXT option from the Iterator list.
3. Enter the name of the session that you have used to open the CSV or text file in the Open action.
4. Seleziona una variabile record dall'elenco Assegna la riga corrente a questa variabile o creane

una nuova.

Nota:  If you select an existing record variable, ensure that the column headers capitalization in the
CSV or text file match that of the schema of the record variable. Schema alla pagina 2036

Insert actions to use the values from the CSV or text file in your automation. Use the record variable to
retrieve the values by index number or column name. For example, if the first column of the file is titled
EmployeeID, to retrieve the value of the first cell of each row enter $rYourVariableName[0]$ or
$rYourVariableName{EmployeeID}$.

Nota:  You must select the Contains header option in the CSV/TXT > Open action to specify the
record values by column name.

For an example, see Build a Bot Insight dashboard bot alla pagina 2089.

Using the For each row in table iterator
Use the For each row in table iterator in the Loop action to read the data of each row in a table variable
and assign the current row to a record variable.
First, retrieve the table values and store them to a table variable.

Example:  Example of extracting data from a web table alla pagina 2053

To use the For each row in table iterator in a Loop action, do the following:
1. Fai doppio clic o trascina l'action Loop dal package Loop nella tavolozza Actions.
2. Select the For each row in table option from the Iterator list.
3. Select the variable that holds the values from the Table variable list.
4. Seleziona una variabile record dall'elenco Assegna la riga corrente a questa variabile o creane

una nuova.
5. Fai clic su Salva.

Insert actions to use the values from the data table in your automation. Use the record variable to
retrieve the values by index number or column name. For example, if the first column of the file is titled
EmployeeID, to retrieve the value of the first cell of each row enter $rYourVariableName[0]$ or
$rYourVariableName{EmployeeID}$.
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Message box package
Use the Message box action from the Message box package to insert a message box that shows a
message when the task runs. For example, you can insert a Message Box action to follow a web form so
that the action displays the message: Web Form Filled and Complete.
Per ulteriori informazioni, consulta Using the Message box action alla pagina 1690.
Use the following examples to learn how to use the Message box action when building automations.
• Build a Go be Great bot alla pagina 2050

Build a basic TaskBot using a Message Box action and a variable.
• Build a basic bot that uses a desktop application alla pagina 2052

An example of how to build a basic TaskBot that uses the calculator application.

Using the Message box action
The Message box action in the Message Box package enables you to insert a message box that shows a
message when the task runs.
1. Double-click or drag the Message box action from the Message box package in the Actions palette.
2. In the Enter the message box window title field, enter a window title for the message box.
3. In the Enter the message to display field, enter a message that you want the bot to display.

This field holds up to 65535 alphanumeric characters, and empty values.

Nota:  Per fornire una stringa che include il simbolo del dollaro ($), devi inserire due simboli di
dollaro. For example, if you enter Pay $$5.00, the output will be Pay $5.00.

4. In the Scrollbar after lines field, specify the number of lines at which you want to show a scroll bar.
5. Opzionale: Select the Close message box after option and specify the number of seconds after

which you want the message box to close automatically.

Importante:  Select this check box if the bot will run on an unattended machine.

6. Fai clic su Salva.

Microsoft LUIS NLP package
The Microsoft LUIS NLP package contains actions that enable you to connect to and consume the
Microsoft Cognitive Services Text Analytics API to identify the language, sentiment, key phrases, and
entities. This package supports the following languages: English, Chinese (Simplified), French, German,
and Spanish.

Importante:  This is a beta package and is currently not available with the Automation 360 Enterprise
and Cloud editions.

Prima di iniziare

You must have an Azure Cognitive Services resource to use these actions. See Create a Cognitive Services
resource using the Azure portal.
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You also require the following in order to use the actions:
• Service Endpoint URL: the endpoint URL that identifies the Azure service.
• Subscription Key: the unique key that authenticates Automation Anywhere Enterprise.

Actions in the Microsoft LUIS NLP package

Action Descrizione

Detect language Identifies the language of the provided content and returns it in ISO 639-1
language code. The output is stored in a string variable.

Get key phrases Identifies the main points and returns a list of key phrases. For example, if
the input text is about a basketball game, this action returns the names of
teams, the name of the venue, and the final score.

Get named entities Identifies the entities in the provided content such as people, places,
organizations, date/time, quantities, branded products, and book titles.
The output is stored in a dictionary variable, where each name is a key,
and the corresponding entity is the value.

Get sentiment Analyzes the provided content and returns a sentiment and score.
• If the score is greater than 0.6, the sentiment is Positive.
• If the score is in the 0.2 through 0.6 range, the sentiment is Neutral.
• If the score is less than 0.2, the sentiment is Negative.

The output is stored in a dictionary variable containing two keys and their
corresponding values: sentiment and score.

Mouse package
Use the Mouse package to simulate mouse actions.

Automation 360 extension setting

If the bot execution takes longer when you use the Mouse packageto simulate mouse actions a static page
running on the Google Chrome or Microsoft Edge browser, then follow these steps to enable the setting in
the Automation 360 extension:
• Click the extensions icon at the top right corner of the browser window.
• Click the vertical ellipses next to the  plugin and select Manage extension.
• Enable the Allow access to file URLs option.
• Restart the browser and run the .

Actions nel package Mouse

Il package Mouse include le seguenti actions:
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Action Descrizione

Fai clic Consulta Using the Click action alla pagina 1692.

Sposta Consulta Using the Move action alla pagina 1694.

Scorri Consulta Using the Scroll action alla pagina 1694.

Registrazione sicura

Quando la modalità di registrazione sicura è abilitata, i bots non visualizzano le immagini dell'oggetto di
destinazione dopo l'acquisizione. Questo assicura che i dati sensibili non vengano mostrati.

Nota:  Anche se i bots non visualizzino le immagini di destinazione dopo l'acquisizione, le immagini sono
ancora memorizzate nella Control Room perché sono necessarie per eseguire i bots.

Quando registri un'attività in modalità di registrazione sicura, la finestra Anteprima mostra
temporaneamente un'immagine dell'area acquisita. Questa immagine è nascosta quando ti allontani dalla
finestra Bot editor o la aggiorni.
Questa impostazione deve essere abilitata da un utente con privilegi di amministratore. Consulta
Impostazioni alla pagina 2721.
Riferimenti correlati
Screen resolution dependent packages alla pagina 2730
The screen resolution between the Bot Runner and Bot Creator device should be consistent as when
resolution-dependent packages are used to build bots, any screen resolution difference between the Bot
Creator and Bot Runner device will impact the bots during runtime.

Using the Click action
The Click action in the Mouse package enables a bot to simulate mouse clicks. This action enables to
capture the UI element such as the screen or window, and to specify the click event and click button.
Ensure that the screen scale and resolution of the Bot Creator device is the same as the Bot Runner
device. If the screen scale and resolution are different, the bot might fail when deployed to the Bot Runner
device.
If you are using Internet Explorer, the bot waits until the browser is completely rendered and is in a ready
state before executing the Click action.
Follow these steps to add a Click action:
1. In the Actions palette, double-click or drag the Click action from the Mouse package.
2. Specify the window in which to capture the mouse click:

Choose from the Application, Browser, or Variable tab.
Opzione Descrizione

Applicazione Select from a list of currently active windows.

Nota:  You can use the Screen option to
capture coordinates on the device screen,
however we recommend specifying a window
because screen sizes can change, which distorts
the captured coordinates.
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Opzione Descrizione

Browser Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based ,
and  browsers.

Variabile seleziona una variabile finestra esistente per
specificare il titolo del titolo della finestra
dell'applicazione.

Nota:  This option deactivates the Capture
option. Use this option only after you have
completed the capture step.

Inserisci un carattere jolly (*) nel campo Titolo della finestra per cercare i titoli delle finestre che
possono cambiare. You can specify one or more wildcards (*) at the start, middle, or end of the
value.For example, to perform an operation on any window that has Microsoft in the title, use
a wildcard to indicate any string by adding it before or after the value: *Microsoft*. The  first
searches for the exact window title (Microsoft), and if it does not find a match, it searches for
windows with the term Microsoft anywhere in the title.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.
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3. Opzionale: Seleziona l'opzione Ridimensiona finestra per specificare le dimensioni della finestra.
This option delivers a more reliable bot. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the botto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Nota:  This option is available only for windows that can be resized. Non è disponibile per le opzioni
Desktop o Barra dei comandi.

4. Click Capture coordinate.
The selected window appears.

5. Drag the mouse to select the click spot and left-click to capture it.
The captured spot appears in the Preview section with the coordinates underneath.

6. In the Button option, specify the button to click.
Choose from Left Button, Right Button, or Middle Button.

7. In the Event option, specify the event.
Choose from Click, Double click, Button up, or Button down.

8. Fai clic su Salva.

Using the Move action
The Move action in the Mouse package enables you to simulate moving the mouse pointer from one
location to another.
Follow these steps to add a Move action:
1. In the Actions palette, double-click or drag the Move action from the Mouse package.
2. In the Mouse from and Mouse to fields, specify the X and Y coordinates.
3. Click Capture coordinate to capture the starting point location.
4. Click Capture coordinate to capture the end point location.
5. Facoltativo: In the Delay in milliseconds field, specify the total duration of the movement in

milliseconds.
6. Fai clic su Salva.

Using the Scroll action
The Scroll action in the Mouse package enables you to simulate scrolling the mouse wheel up or down.
Follow these steps to add a Scroll action:
1. In the Actions palette, double-click or drag the Scroll action from the Mouse package.
2. In the Select scroll option, select the Up or Down option.
3. In the Number of iterations field, specify the number of times to scroll.
4. Opzionale: In the Delay in milliseconds field, specify the total duration of the scrolling in

milliseconds.
5. Fai clic su Salva.
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Number package
Il package Number contiene actions che consentono di eseguire varie operazioni su una variabile numerica.
Una variabile numerica contiene valori numerici, inclusi numeri interi e decimali. Contiene valori compresi
tra -9.223.372.036.854.775.808 e 9.223.372.036.854.775.807 e fino a 15 cifre decimali.

Actions nel package Number

Le actions nel package Number accettano una variabile come input e assegnano l'output a una variabile.
Queste actions consentono di assegnare un valore a una variabile numerica, decrementare o incrementare
un numero o convertire una variabile numerica in una variabile stringa.
Si possono usare numeri grandi nelle variabili numeriche o in actions per eseguire operazioni matematiche.
Nell'editor di bot, usa il menu azioni (puntini di sospensione verticali in alto a destra) per selezionare
Impostazioni avanzate > Abilita il supporto migliorato dei numeri.

Nota:  Assicurati di aggiornare alla versione più recente del package per utilizzare questa funzione.

Il package Number include le seguenti actions:

Action Descrizione

Assegna Vedi Assign action in Number alla pagina 1695

Diminuisci Vedi Decrement action in Number alla pagina 1695

Aumenta Vedi Increment action in Number alla pagina 1696

Casuale Vedi Random action in Number alla pagina 1696

To string Vedi To string action in Number alla pagina 1696

Assign action in Number
The Assign action in the Number package enables you to assign a specified number or result of an
expression to a user-defined Number variable. Puoi utilizzare le espressioni create utilizzando gli operatori
+, -, * e /, nonché utilizzare le parentesi per raggruppare le espressioni. Ad esempio, (3*4)+5 o
($Variable2*$Variable3)/$Variable1.

Impostazioni

• In the Select the source number variable/value, enter a number or select a predefined Number
variable.

• In the Select the destination number variable, select a predefined Number variable or create a new
one to hold the output.

Decrement action in Number
The Decrement action in the Number package enables you to decrement (decreases by set intervals) a
number by a user-specified value.

Impostazioni

• In the Enter number field, enter a number or select a predefined Number variable.
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• In the Enter decrement value field, enter the decrement value or select a predefined Number
variable.

• In the Assign the output to variable field, select a predefined Number variable or create a new one
to hold the output.

Increment action in Number
The Increment action in the Number package enables you to increment (increases by set intervals) a
number by a user-specified value.

Impostazioni

• In the Enter number field, enter a number or select a predefined Number variable.
• In the Enter increment value field, enter the increment value, the value must be greater than zero or

select a predefined Number variable.
• In the Assign the output to variable field, select a predefined Number variable or create a new one

to hold the output.

Random action in Number
The Random action in the Number package enables you to generate a random integer from a user-
specified range and assign it to a number variable.

Impostazioni

• Nel campo Inizio intervallo, immetti un numero o seleziona una variabile numerica predefinita.

Nota:  Questo campo accetta valori compresi tra -9.223.372.036.854.775.808 e
9.223.372.036.854.775.807 e fino a 15 cifre decimali.

• In the End of range field, enter a number or select a predefined number variable that is greater than
the value in the Beginning of range field.

Nota:  Questo campo accetta valori compresi tra -9.223.372.036.854.775.808 e
9.223.372.036.854.775.807 e fino a 15 cifre decimali.

• Immetti il numero di cifre dopo il decimale selezionando la casella di controllo Specifica il numero di
decimali.

• In the Save the outcome to a variable field, select a predefined Number variable or create a new
one to hold the output.

To string action in Number
The To string action in the Number package enables you to convert a user-specified number to a string.

Impostazioni

• In the Enter number field, enter a number or select a predefined Number variable.
• In the Enter number of digits after decimal field, enter the amount of digits after the decimal.

Per rimuovere tutte le cifre dopo il decimale, lascia il valore predefinito 0.
• In the Assign the output to variable field, select a pre-defined String variable or create a new one to

hold the output. You can use prompt-assignment during building and testing of the bot.
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Importante:  Ensure that you reassign the values from prompt-assignment to a user-created variable
before deploying the bot into production.

OCR package
Il OCR package contiene actions che consentono di estrarre il testo da immagini o applicazioni.
Il OCR package consente di:
• Extract text from a window or a specific area of an application.
• Extract text from images or files stored on a local machine, a website, or the Control Room folder.
• Filter extracted text and store it as a variable.

Nota:  You can extract text from images in .jpeg, .jpg, .bmp, .gif, and .png formats.

ABBYY FineReader 12.2.27.12 è installato insieme ad A2019 e non richiede alcuna configurazione
aggiuntiva.

Actions nel package OCR

Il package OCR include le seguenti actions:

Action Descrizione

Acquisisci immagine
dal percorso

Consulta Using Capture image by path action alla pagina 1698.

Acquisisci immagine
per URL

Consulta Using Capture image by URL action alla pagina 1698.

Acquisisci la finestra Consulta Using Capture window action from OCR package alla pagina 1699.

Acquisisci l’area Consulta Using Capture area action from OCR package alla pagina 1701.

Registrazione sicura

Quando la modalità di registrazione sicura è abilitata, i bots non visualizzano le immagini dell'oggetto di
destinazione dopo l'acquisizione. Questo assicura che i dati sensibili non vengano mostrati.

Nota:  Anche se i bots non visualizzino le immagini di destinazione dopo l'acquisizione, le immagini sono
ancora memorizzate nella Control Room perché sono necessarie per eseguire i bots.

Quando registri un'attività in modalità di registrazione sicura, la finestra Anteprima mostra
temporaneamente un'immagine dell'area acquisita. Questa immagine è nascosta quando ti allontani dalla
finestra Bot editor o la aggiorni.
Questa impostazione deve essere abilitata da un utente con privilegi di amministratore. Consulta
Impostazioni alla pagina 2721.
Riferimenti correlati
Screen resolution dependent packages alla pagina 2730
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The screen resolution between the Bot Runner and Bot Creator device should be consistent as when
resolution-dependent packages are used to build bots, any screen resolution difference between the Bot
Creator and Bot Runner device will impact the bots during runtime.

Using Capture image by path action
Use the Capture image by path action to extract text from an image on a device or a folder in the
Control Room. The extracted text can assigned as a variable.
Follow these steps to use the Capture image by path action:
1. In the Actions palette, double-click or drag the Capture image by path action from the OCR

package.
2. In the Image path field, select an option:

• File Control Room: Uses a file that is available on the Control Room.
• File desktop: Uses a file that is available on a device.
• Variabile: Uses a file variable to specify the file location.

3. Select the Filter the captured text check box to filter the captured text.
Specify the text to filter out in the Before and After fields. For example, if the extracted text is
Name: ABC Inc. Location:, to retrieve ABC Inc., you must specify Location: in the Before
field and Name: in the After field.

4. Select the Trim the captured text check box to trim the extra spaces.
5. Select the Load Profile check box and select an option to load the locale based on the ABBYY profile:

Nota:  ABBYY FineReader 12.2.27.12 è installato insieme ad A2019 e non richiede alcuna
configurazione aggiuntiva.

• File Control Room: Uses a file that is available on the Control Room.
• File desktop: Uses a file that is available on a device.
• Variabile: Uses a file variable to specify the file location.

6. In the Select locale list, select the language of the device.

Nota:  Currently, only English, Japanese, and Russian locales are supported. If you have selected an
option from the Select locale list and the Load Profile option, the system considers the locale based
on the Load Profile selection.

7. In the Assign value to variable list, select a string variable.
8. Fai clic su Salva.

Using Capture image by URL action
Use the Capture image by url action to extract text from an online image. You can filter the extracted
text and assign it to a string variable.
Follow these steps to use the Capture image by url action:
1. In the Actions palette, double-click or drag the Capture image by url action from the OCR

package.
2. In the Image url field, specify the URL.

Nota:  A URL of an image on a shared drive or an FTP server is not supported.
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3. Select the Filter the captured text check box to filter the captured text.
Specify the text to filter out in the Before and After fields. For example, if the extracted text is
Name: ABC Inc. Location:, to retrieve ABC Inc., you must specify Location: in the Before
field and Name: in the After field.

4. Select the Trim the captured text check box to trim the extra spaces.
5. Select the Load Profile check box and select an option to load the locale based on the ABBYY profile:

Nota:  ABBYY FineReader 12.2.27.12 è installato insieme ad A2019 e non richiede alcuna
configurazione aggiuntiva.

• File Control Room: Uses a file that is available on the Control Room.
• File desktop: Uses a file that is available on a device.
• Variabile: Uses a file variable to specify the file location.

6. In the Select locale list, select the language of the device.

Nota:  Currently, only English, Japanese, and Russian locales are supported. If you have selected an
option from the Select locale list and the Load Profile option, the system considers the locale based
on the Load Profile selection.

7. In the Assign value to variable list, select a string variable.
8. Fai clic su Salva.

Using Capture window action from OCR package
Use the Capture window action to extract text from an application window. You can filter the extracted
text and assign it to a string variable.
Follow these steps to use the Capture window action:
1. In the Actions palette, double-click or drag the Capture window action from the OCR package.
2. In the Window title field, select an option:

• Finestra: Captures a window on a desktop. In the Window title field, specify the application
title.

• Variabile: Inserts an existing window variable. Click Variable tab to create a new string variable.

Inserisci un carattere jolly (*) nel campo Titolo della finestra per cercare i titoli delle finestre che
possono cambiare. You can specify one or more wildcards (*) at the start, middle, or end of the
value.For example, to perform an operation on any window that has Microsoft in the title, use
a wildcard to indicate any string by adding it before or after the value: *Microsoft*. The  first

© 2023 Automation Anywhere. All rights reserved.     1699



    Automation Anywhere - Crea

searches for the exact window title (Microsoft), and if it does not find a match, it searches for
windows with the term Microsoft anywhere in the title.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

3. Opzionale: Seleziona l'opzione Ridimensiona finestra per specificare le dimensioni della finestra.
This option delivers a more reliable bot. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the botto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Nota:  This option is available only for windows that can be resized. Non è disponibile per le opzioni
Desktop o Barra dei comandi.

4. In the Wait before capturing the image (ms) field, specify the delay time.

Recommendation:  If you are capturing in a window that is accessed using Remote Desktop
Protocol (RDP), set a minimum delay time of 1000 milliseconds to give the window time to load.

5. Select the Filter the captured text check box to filter the captured text.
Specify the text to filter out in the Before and After fields. For example, if the extracted text is
Name: ABC Inc. Location:, to retrieve ABC Inc., you must specify Location: in the Before
field and Name: in the After field.

6. Select the Trim the captured text check box to trim the extra spaces.
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7. Select the Load Profile check box and select an option to load the locale based on the ABBYY profile:

Nota:  ABBYY FineReader 12.2.27.12 è installato insieme ad A2019 e non richiede alcuna
configurazione aggiuntiva.

• File Control Room: Uses a file that is available on the Control Room.
• File desktop: Uses a file that is available on a device.
• Variabile: Uses a file variable to specify the file location.

8. In the Select locale list, select the language of the device.

Nota:  Currently, only English, Japanese, and Russian locales are supported. If you have selected an
option from the Select locale list and the Load Profile option, the system considers the locale based
on the Load Profile selection.

9. In the Assign value to variable list, select a string variable.
10. Fai clic su Salva.

Using Capture area action from OCR package
Use the Capture area action to extract text from a specific area in an application window. You can filter
the extracted text and assign it as a variable.
Follow these steps to use the Capture area action:
1. In the Actions palette, double-click or drag the Capture area action from the OCR package.
2. In the Window title field, select an option:

• Finestra: Captures a window on a desktop. In the Window title field, specify the application
title.

• Variabile: Inserts an existing window variable.

Inserisci un carattere jolly (*) nel campo Titolo della finestra per cercare i titoli delle finestre che
possono cambiare. You can specify one or more wildcards (*) at the start, middle, or end of the
value.For example, to perform an operation on any window that has Microsoft in the title, use
a wildcard to indicate any string by adding it before or after the value: *Microsoft*. The  first
searches for the exact window title (Microsoft), and if it does not find a match, it searches for
windows with the term Microsoft anywhere in the title.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
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you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

3. Opzionale: Seleziona l'opzione Ridimensiona finestra per specificare le dimensioni della finestra.
This option delivers a more reliable bot. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the botto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Nota:  This option is available only for windows that can be resized. Non è disponibile per le opzioni
Desktop o Barra dei comandi.

4. Specify the X, Y, Width, and Height coordinates.
5. Click Capture region.

The bot captures text from the visible area of the screen even if the target area is below the visible
screen.

6. In the Wait before capturing the image (ms) field, specify the delay time.

Recommendation:  If you are capturing in a window that is accessed using Remote Desktop
Protocol (RDP), set a minimum delay time of 1000 milliseconds to give the window time to load.

7. Select the Filter the captured text check box to filter the captured text.
Specify the text to filter out in the Before and After fields. For example, if the extracted text is
Name: ABC Inc. Location:, to retrieve ABC Inc., you must specify Location: in the Before
field and Name: in the After field.

8. Select the Trim the captured text check box to trim the extra spaces.
9. Select the Load Profile check box and select an option to load the locale based on the ABBYY profile:

Nota:  ABBYY FineReader 12.2.27.12 è installato insieme ad A2019 e non richiede alcuna
configurazione aggiuntiva.

• File Control Room: Uses a file that is available on the Control Room.
• File desktop: Uses a file that is available on a device.
• Variabile: Uses a file variable to specify the file location.

10. In the Select locale list, select the language of the device.

Nota:  Currently, only English, Japanese, and Russian locales are supported. If you have selected an
option from the Select locale list and the Load Profile option, the system considers the locale based
on the Load Profile selection.

11. In the Assign value to variable list, select a string variable.
12. Fai clic su Salva.
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Office 365 Calendar package
The Office 365 Calendar package contains actions that enable you to automate meeting-related tasks in
Office 365 Calendar.

Prima di iniziare

Perform the following actions within the Office 365 Calendar package as part of using the set of
available actions:
1. Use the Connect action to establish a connection to the Office 365 server.

Consulta Using Connect action for Office 365 packages alla pagina 1705.

Nota:  Office 365 packages do not currently support Multi-Factor Authentication or Single Sign-on.

2. Use a combination of actions available in this package to automate tasks.

Nota:  To use actions from other Office 365 packages, establish a connection using the Connect
action from that package.

3. Utilizza l'action Disconnetti per terminare la connessione.

Actions in the Office 365 Calendar package

The Office 365 Calendar package includes the following actions:

Nota:  Some of the actions must be used within a Loop action to apply the action to each meeting in the
calendar. Consulta Using Office 365 Calendar actions in a loop alla pagina 1709.

Action Descrizione

Aggiungi allegato Vedi Add attachment action in Office 365 Calendar
alla pagina 1704

Aggiungi partecipanti Vedi Add attendees action in Office 365 Calendar
alla pagina 1704

Annulla riunione Vedi Cancel meeting action in Office 365 Calendar
alla pagina 1704

Connetti Establishes a connection with the Office 365
server using your organization's client ID and
tenant ID, and user credentials.
Consulta Using Connect action for Office 365
packages alla pagina 1705.

Crea riunione Consulta Using the Create Meeting action alla
pagina 1706.

Delete attendees Vedi Delete attendees action in Office 365 Calendar
alla pagina 1707

Elimina informazioni riunione Vedi Delete meeting information action in Office 365
Calendar alla pagina 1707
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Action Descrizione

Disconnetti Terminates the connection with the Office 365
server. Enter the session name that you used in
the Connect action. Insert this action at the end
of automation sequences that use actions from
this Office 365 package. Consulta Disconnect
action for Office 365 packages alla pagina 1708.

Ottieni disponibilità oraria per riunioni Consulta Using the Get available meeting slots
action alla pagina 1708.

Modifica riunione Vedi Modify meeting action in Office 365 Calendar
alla pagina 1708

Rispondi alla riunione Vedi Respond to meeting action in Office 365
Calendar alla pagina 1709

Add attachment action in Office 365 Calendar
The Add attachment action in the Office 365 Calendar package enables you to add one or more
attachments to a meeting.

Impostazioni

Use this action within a Loop action to repeat this operation for each meeting in the calendar. Vedi Loop
package alla pagina 1681.
• Provide the session name that you used in the Connect action.
• Select the files to attach from the Control Room or your desktop, or insert a file variable. Separate each

file path with a comma.

Add attendees action in Office 365 Calendar
The Add attendees action in the Office 365 Calendar package enables you to add one or more attendees
to a meeting and specifies whether attendance is optional or required.

Impostazioni

During run time, this  triggers an email notification to meeting attendees. Use this  within a Loop  to
repeat this operation for each meeting in the calendar. Vedi Loop package alla pagina 1681.
• Provide the session name that you used in the Connect .
• Enter the attendee emails into the Required or Optional fields. Separate each email with a comma.

Cancel meeting action in Office 365 Calendar
The Cancel meeting action in the Office 365 Calendar package enables you to cancel the meeting.

Impostazioni

During run time, this  triggers an email notification to meeting attendees. Use this  within a Loop  to
repeat this operation for each meeting in the calendar. Vedi Loop package alla pagina 1681.
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Using Connect action for Office 365 packages
Use the Connect action to establish a connection with the Office 365 server using your organization's
(client ID and tenant ID) and user credentials. All of the fields in this action accept a credential from the
Credential Vault or a user-input value.

Nota:
• The Connect action does not currently support Multi-Factor Authentication or Single Sign-on.
• The best practice is for a system administrator to perform the following steps.

1. Log in to the Azure portal using your Office 365 credentials.
2. Register your application with the Microsoft identity platform to obtain the client ID and tenant ID. See

Register your app.
3. Grant the required permissions for Microsoft Graph to the application. Consulta Permissions for

application alla pagina 1705.
4. To add a client secret, you must first subscribe to Azure. See Subscribe to Azure.
5. Add a client secret. See Add a client secret.

For an example on how to setup and connect to the Office 365 OneDrive package, see Working with the
Office 365 OneDrive package.
To establish a connection to the Office 365 server, follow these steps:
1. Nella tavolozza Actions, fai doppio clic o trascina l'action Connetti dal package che desideri

utilizzare.
2. In the User session field, enter a name for this session.

Provide this session name in subsequent actions from this package.
3. In the Username and Password fields, enter your user credentials or insert them from the

Credential Vault.
4. In the Tenant ID field, enter the unique ID for your Office 365 subscription or insert it from the

Credential Vault.
5. In the Client ID field, enter the Office 365 client or insert it from the Credential Vault.
6. In the Client Secret Key field enter your access token or insert it from the Credential Vault.
7. Fai clic su Salva.

Permissions for application
After registering the Office 365, you must grant certain permissions to the application. These permissions
are required to enable Office 365 packages to perform various operations.
To grant permissions to an application, see Add permissions.

Nota:  You must be the co-owner of the application for which you are configuring permissions.

The following Delegated permissions for Microsoft Graph are required for Office 365 packages:

Common permissions

openid

offline_access
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User.Read

User.ReadBasic.All

One Drive

Files.ReadWrite.All

Sites.ReadWrite.All

Calendar

Calendars.Read

Calendars.Read.Shared

Calendars.ReadWrite

E-mail

Mail.Read

Mail.ReadWrite

MailboxSettings.Read

MailboxSettings.ReadWrite

Directory

Directory.AccessAsUser.All

Directory.ReadWriter.All

Apart from the above permissions, you can grant additional permissions based on your requirements. See,
Microsoft Graph permission reference.

Using the Create Meeting action
Use the Create Meeting action to specify a meeting agenda, attachments, attendees, duration, location,
recurrence, and title. During run time, this action sends an invitation email to meeting attendees.
This action uses two Datetime variables to set the meeting start and end. Define the values before you
start. The recurrence option also uses two Datetime variables to set the start and end. Per ulteriori
informazioni, consulta Le tue variabili (definite dall'utente) alla pagina 2026.
To create a meeting, do the following:
1. Enter the session name that you used in the Connect action.
2. Enter the calendar name.

Questo campo è sensibile alla distinzione tra maiuscole/minuscole.
The prepopulated value is Calendar; this is the default Office 365 setting.

3. Specify the meeting start date and time.
Select a DateTime variable from the drop-down list.

4. Specify the meeting end date and time.
Select a DateTime variable with a value that is the same or after the start time.

5. Opzionale: Mark the All day meeting option.
For an all day meeting, ensure that there is a one-day difference between the start and end dates.

6. Enter attendee email addresses, separated by commas.
7. Opzionale: Enter the following details:
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• Attach a file from the Control Room, Desktop, or insert a File variable.
• Enter a meeting title.
• Enter a meeting location.
• Enter an agenda.
• Set a reminder.
• Set a recurrence with the following options:

• Select the recurrence type: Daily, Weekly, Monthly, or Yearly.
• For Weekly recurrence, mark the days of the week on which the meeting takes place.
• For Monthly recurrence, either enter the numerical date or select a day.

For example, to schedule a meeting that takes place on the twenty-fifth day of the month
enter 25 in the Specific date field.

Nota:  If you enter 31 in the Specific date field, for the months with less than 31 days, the
meeting will schedule for the last day of the month.

To schedule it for the last Monday of the month, select Last from the Occurrence drop-
down list and Monday from the Weekday drop-down list.

• For Yearly recurrence, either enter the numerical date and month or select a day and
month.
For example, to schedule a meeting that takes place on March 15, enter 15 in the Specific
Date field and March in the Month field. To schedule it for the second Friday in March,
select Second from the Occurrence drop-down list, select Friday from the Weekday
drop-down list, and March from the Month drop-down list.

• Enter the recurrence frequency.
• Specify the recurrence start by selecting a DateTime variable from the drop-down list.
• If the recurrence has an end date, select a DateTime variable from the drop-down list.

Delete attendees action in Office 365 Calendar
The Delete attendees action in the Office 365 Calendar package enables you to delete attendees from a
meeting.

Impostazioni

During run time, this action triggers an email notification to meeting attendees. Use this  within a Loop  to
repeat this operation for each meeting in the calendar. Vedi Loop package alla pagina 1681.
• Provide the session name that you used in the Connect .
• Select an option to delete: meeting or attendees. To delete attendees, provide the email addresses

of the attendees, separated by commas.

Delete meeting information action in Office 365 Calendar
The Delete meeting information action in the Office 365 Calendar package enables you to delete
information related to a meeting such as the title or location.
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Impostazioni

Use this  within a Loop  to repeat this operation for each meeting in the calendar. Vedi Loop package alla
pagina 1681.
• Provide the session name that you used in the Connect .
• Select the meeting information to delete. The options are:

• Titolo
• Luogo
• Ordine del giorno
• Promemoria
• Ricorrenza
• Per l'intera giornata

Disconnect action for Office 365 packages
Use the Disconnect action from the specific Office 365 package to terminate the connection from the Office
365 application.

Impostazioni

Enter the user session that you provided in the Connect action.

Using the Get available meeting slots action
Use the Get available meeting slots action to retrieve available time slots for attendees in a specified
date and time range. This action supports scheduling across time zones.
This action considers a time slot as available if it is within an attendee's working hours and if the attendee
has not already accepted a meeting for that time. If an attendee tentatively responds or does not respond
to an invitation, this action considers them available.
To retrieve available time slots, perform the following steps:
1. Enter the session name that you used in the Connect action.
2. Enter the email addresses of the attendees, separated by commas.
3. Enter the duration of the meeting in minutes.
4. Specify the range start date and time by selecting a DateTime variable from the drop-down list.
5. Specify the range end date and time by select a DateTime variable with a value that is the same or

after the start time.
6. Opzionale: Select the Check for timeslots outside working hours option.
7. Select a Table variable from the drop-down list.
8. Fai clic su Salva.

Modify meeting action in Office 365 Calendar
The Modify meeting actionin the Office 365 Calendar package enables you to modify information for a
meeting.
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Impostazioni

Use this  within a Loop  to repeat this operation for each meeting in the calendar. Vedi Loop package alla
pagina 1681.

• Provide the session name that you used in the Connect .
• Modify any of the following:

• Meeting start or end date.
• Convert the meeting to all day.
• Revise the meeting title.
• Revise the agenda.
• Update the location.
• Update the reminder.
• Update the recurrence, frequency, start date, and end date.

Respond to meeting action in Office 365 Calendar
The Respond to meeting action in the Office 365 Calendar package enables you to respond to a meeting
as accepted, rejected, or tentative.

Impostazioni

You can also add a message to the response.
Use this  within a Loop  to repeat this operation for each meeting in the calendar. Vedi Loop package alla
pagina 1681.

Using Office 365 Calendar actions in a loop
You must use certain Office 365 Calendar actions within a Loop action.
This action uses two Datetime variables to set the meeting start and end. Define the values before you
start. Per ulteriori informazioni, consulta Le tue variabili (definite dall'utente) alla pagina 2026.
To use an Office 365 Calendar action within a loop, follow these steps:
1. Fai doppio clic o trascina l'action Loop dal package Loop nella tavolozza Actions.
2. Select the For each meeting in calendar iterator.
3. Enter the session name that you used in the Connect action.
4. Enter the calendar name.

Questo campo è sensibile alla distinzione tra maiuscole/minuscole.
The prepopulated value is Calendar; this is the default Office 365 setting.

5. Select whether to loop through All meetings in the calendar or only meetings with the specific title.
6. Specify the meeting start date and time.

Select a DateTime variable from the drop-down list.
7. Specify the meeting end date and time.

Select a DateTime variable with a value that is the same or after the start time.
8. Opzionale: Enter the location.
9. Opzionale: Enter the duration in minutes.
10. Opzionale: Mark the All day meeting option.

For an all day meeting, ensure that there is a one-day difference between the start and end dates.
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11. Opzionale: Enter the meeting owner's email address.
12. Select or create a record variable to hold the output.

Office 365 Excel package
The Office 365 Excel package contains actions that enable you to automate tasks in the online version of
Microsoft Excel.

Choosing the Excel package in Automation 360

Automation 360 includes packages to support three types of Microsoft Excel usage. For optimal results, use
the package that corresponds to the type of Excel that is available on the device you are running bots on.
• Nessun Excel installato: If you do not have Microsoft Excel installed on the device on which you are

running bots to automate Excel-related processes, use the Excel basic package.
• Installata la versione desktop di Excel: If you have a desktop version of Microsoft Excel installed

on your computer, use the Excel advanced package in your bots.
• Solo Office 365 Excel online: If you are using Microsoft Excel 365 on a web browser, use the Office

365 Excel package for automating tasks related to Excel.

Prima di iniziare

1. Use the Connect action to establish a connection to the Office 365 server.
Consulta Using Connect action for Office 365 packages alla pagina 1705.

Nota:  Office 365 packages do not currently support Multi-Factor Authentication or Single Sign-on.

2. Use the Open action to select a workbook, or the Create action to create a new workbook. Consulta
Workbook operations in Office 365 Excel alla pagina 1722.

3. Facoltativo: If the workbook contains more than one worksheet, use the Activate sheet action to
specify which worksheet to use.

4. Use a combination of actions available in this package to automate tasks.

Nota:  To use actions from other Office 365 packages, establish a connection using the Connect
action from that package.

5. Use the Close action to exit from the workbook.
6. Utilizza l'action Disconnetti per terminare la connessione.

Actions nel package Office 365 Excel
The actions in the Office 365 Excel package enable you to perform the following operations:
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Operazioni Descrizione

Cella Perform operations related to cell and range
operations, such as append, delete, format, get
properties, and insert.
Vedi Cell operations in Office 365 Excel alla pagina
1711

Row and column Perform operations related to column and row
operations such as autofit, delete, and read.
Consulta Column/Row operations in Office 365
Excel alla pagina 1717.

Tabella Perform operations related to the table
operations such as create, delete, filter, get
properties, rename, and sort. Consulta Table
operations in Office 365 Excel alla pagina 1720.

Workbook Automate opening, closing, and creating a
workbook.
Consulta Workbook operations in Office 365 Excel
alla pagina 1722.

Worksheet Perform operations related to worksheet
operations, such as activate, delete, find, get
worksheet names, hide, retrieve worksheet
count, and show.
Consulta Worksheet operations in Office 365 Excel
alla pagina 1723.

Cell operations in Office 365 Excel
The Office 365 Excel package contains actions that you can use to automate tasks related to cell and
range operations, such as append, delete, format, get properties, and insert.
The Office 365 Excel package includes the following actions:

Action Descrizione

Elimina cella Consulta Delete cell action in Office 365 Excel alla pagina 1712.

Elimina intervallo Consulta Delete range action in Office 365 Excel alla pagina 1712.

Formatta cella Consulta Using the Format cell action alla pagina 1712.

Ottieni valore Consulta Get cell action in Office 365 Excel alla pagina 1713.

Ottieni colore cella o testo Consulta Using the Get cell/text color action alla pagina 1714.

Ottieni più celle Consulta Get multiple cells action in Office 365 Excel alla pagina
1714.

Vai alla cella Consulta Go to cell action in Office 365 Excel alla pagina 1714.

Inserisci cella Consulta Insert cell action in Office 365 Excel alla pagina 1715.

Inserisci intervallo Consulta Insert range action in Office 365 Excel alla pagina 1715.

Incolla cella Consulta Paste cell action in Office 365 Excel alla pagina 1715.
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Action Descrizione

Leggi formato della cella Consulta Read cell format action in Office 365 Excel alla pagina
1716.

Leggi formula della cella Consulta Read cell formula action in Office 365 Excel alla pagina
1716.

Imposta cella Consulta Set cell action in Office 365 Excel alla pagina 1716.

Imposta colore cella Consulta Set cell color action in Office 365 Excel alla pagina 1716.

Imposta formula cella Consulta Set cell formula action in Office 365 Excel alla pagina 1717.

Delete cell action in Office 365 Excel
The Delete cell action in Office 365 Excel enables you to delete an active cell or a specific cell from the
current worksheet.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Select either the active cell or a specific cell. If you select Specific cell, enter the cell location. For

example A1.
• From the delete options, select one of the following options:

• Sposta celle a sinistra: Deletes the specified cell and shifts the cell one position to left.
• Sposta celle verso l'alto: Deletes the specified cell and shifts the cell one position up.
• Intera riga: Deletes the entire row that contains the cell that you have specified to delete.
• Intera colonna: Deletes the entire column that contains the cell that you have specified to delete.

Delete range action in Office 365 Excel
The Delete range action in Office 365 Excel enables you to delete a specific range of cells.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Enter the cell range. Ad esempio A1:B4. This deletes an area consisting of the first four rows by the

first two columns.
• Specify whether to shift the cells up or left.

• Sposta celle verso l'alto: Deletes the specified cells and shifts the cells up by the number of rows
deleted.

• Sposta celle a sinistra: Deletes the specified cells and shifts the cells left by the number of
columns deleted.

Using the Format cell action
Use the Format cell action to set the format of a cell or group of cells.
To format a cell or group of cells, do the following:
1. Double-click or drag the Format cell action.
2. Enter the name of the session used to open the workbook with the Open .
3. Select the Active cell, Specific cell, or Multiple cells option and provide cell location or cell range,

as necessary.
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4. Mark the Font option to modify any of the following:
• Nome carattere
• Font size (between 8 and 72)
• Bold or italicize
• Sottolineato
• Font color (accepts color name or hex value). For a list of color names and corresponding hex

values, see Frequently used cell colors alla pagina 1713.

5. Mark the Alignment option, then use the drop-down lists to modify the vertical or horizontal
alignment.

6. Mark the wrap text option to expand the cell(s) vertically to show long strings of text.
7. Mark the Merge Type option to select the any of the following operations:

• Merge and center
• Merge across
• Merge cells
• Unmerge

8. Fai clic su Salva.

Frequently used cell colors
Review the color names and their corresponding hex values you can use to set a cell color for a cell or text
within a cell in a worksheet. These are the most frequently used options for formatting worksheets.

Nome Hex

Aqua #00FFFF

Black #000000

Blue #0000FF

Gray #808080

Green #008000

Fuchsia #FF00FF

Lime #00FF00

Maroon #800000

Navy #000080

Olive #808000

Purple #800080

Red #FF0000

Silver #C0C0C0

Teal #008080

White #FFFFFF

Yellow #FFFF00

Get cell action in Office 365 Excel
Use the Get cell action in Office 365 Excel to retrieve the value of a cell.

© 2023 Automation Anywhere. All rights reserved.     1713



    Automation Anywhere - Crea

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Select either an Active cell or Specific cell. If you select a specific cell, enter the cell location.
• Puoi assegnare l'output a una variabile stringa. To perform mathematical operations, convert the string

to a number using the String > To number. Consulta To number action alla pagina 1890.

Using the Get cell/text color action
Use the Get cell/text color action to get the color of the background or text in a cell. This action
retrieves the color of a cell as RGB values. For example, if the background or text in a cell is of red color,
the value retrieved is 255,0,0.
To get the color of the background or text in a cell, do the following:
1. Double-click or drag the Get cell/text color action.
2. Enter the name of the session used to open the workbook with the Open .
3. Select the Active cell option to get the color from the current active cell or the Specific cell option

to get the color from the address of the cell you have specified.
4. Select the Cell color option to get the background color of the cell, the Text color option to get the

color of the text, or both.
5. Specify whether to retrieve the cell color by name or as an RGB value.
6. Select a variable from the Assign the output to variable list to assign the cell/text color to a List

variable.
7. Fai clic su Salva.

If both cell and text colors are retrieved, the List variable contains the cell color at index 0 and text
color at index 1.

Get multiple cells action in Office 365 Excel
Use the Get multiple cells action in Office 365 Excel to retrieve the values of multiple cells within a
worksheet and assign the output to a variable.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Select either the Multiple cells or All cells option. If you select Multiple cells, enter the cell range.

For example, if you enter A1:D1,values of the first four cells in the top row are retrieved.
• Puoi assegnare l'output a una variabile stringa. To convert the string to a number, use the String > To

number action. Consulta To number action alla pagina 1890.

Go to cell action in Office 365 Excel
Use the Go to cell action in Office 365 Excel to move the cursor to a specific cell in the worksheet.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
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• Select from the following cell options:
• Specific cell: Moves to the specified cell address.
• One cell to the left: Moves one cell left.
• One cell to the right: Moves one cell right.
• One cell above: Moves one cell up.
• One cell below: Moves one cell down.
• Beginning of the row: Moves to the first cell in the same row.
• End of the row: Moves to the last cell that contains data in the same row.
• Beginning of the column: Moves to the first cell in the same column.
• End of the column: Moves to the last cell that contains data in the same column.

Insert cell action in Office 365 Excel
Use the Insert cell action in Office 365 Excel to insert a value to an active cell or a specific cell in the
current worksheet without overwriting the existing value.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Select either Active cell or Specific cell. If you select Specific cell, enter the cell location, for

example A1.
• After inserting the cell, you can perform these operations:

• Shift cell > Down: Shifts the existing values down by the specified number of rows.
• Shift cell > Right: Shifts the existing values right by the specified number of columns.

Insert range action in Office 365 Excel
Use the Insert range action in Office 365 Excel to insert a range in the current worksheet without
overwriting the existing value.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Enter the cell range, for example A1:B4. This inserts a range of cells consisting of the first four rows by

the first two columns.
• After inserting the cell, you can perform these operations:

• Shift cell > Down: Shifts the existing values down by the specified number of rows.
• Shift cell > Right: Shifts the existing values right by the specified number of columns.

Paste cell action in Office 365 Excel
Use the Paste cell action in Office 365 Excel to copy a value from a cell and paste it to a specified cell. If
there is a value in the destination cell, this action will overwrite the value.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Select either the Active cell or Specific cell option to specify the cell from which to copy the value. If

you have selected the Specific cell option, specify the address of the cell in the Cell name field.
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• Enter the destination cell address to paste the value. Ad esempio, B3.

Read cell format action in Office 365 Excel
Use the Read cell format action to retrieve the format of an active or a specified cell (such as vertical or
horizontal alignment and wrap text) and assign the output to a string variable.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Select the Active cell or Specific cell option to specify the cell from which to read the format. If you

have selected the Specific cell option, specify the address of the cell in the Cell name field.
• Select a String variable to store the cell format from the Assign the output to variable list.

Read cell formula action in Office 365 Excel
Use the Read cell formula action to retrieve a formula from an active or a specific cell and assign the
output to a string variable. This action returns a blank value if the specified cell does not contain a formula.

Impostazioni

• Enter the name of the session used to open the workbook with the Open .
• Select the Active cell or Specific cell option to specify the cell from which to read the formula. If you

have selected the Specific option, specify the address of the cell in the field.
• Select a string variable to store the name of the formula from the Assign the output to variable

list. La  mostra un nome descrittivo predefinito della variabile. If you create several output variables,
subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.

Set cell action in Office 365 Excel
Use the Set cell action to set a value in an active or a specific cell of an Excel spreadsheet or a CSV file.
You can also use this action to set a formula.

Impostazioni

• Enter the name of the session used to open the workbook with the Open .
• Select the Active cell or Specific cell option to specify the cell in which to set the value. If you have

selected the Specific cell option, specify the address of the cell in the field.

Nota:  Puoi immettere un intervallo di celle nel campo Cella specifica per impostare un valore
particolare in tutte le celle dell'intervallo. Ad esempio, per impostare un valore di 5 in tutte le celle nella
seconda riga e dalla prima alla terza colonna, immetti A2:C2.

• Inserisci il valore da impostare nel campo Valore cella.

Set cell color action in Office 365 Excel
Use the Set cell color action to set a color to the background or text of an active cell or a Specific cell in a
worksheet.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Select the Active cell, Specific cell, or Cell range option to specify the cell in which to set the color.

If you have selected the Specific cell option, specify the address of the cell in the Cell name field.
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• Select the item to which you want to apply the color: Cell or Text within cell.
• Enter a cell color by name or code.

Use either the color name or the hex value. For a list of color names and corresponding hex values, see
Frequently used cell colors alla pagina 1713.

Set cell formula action in Office 365 Excel
The set cell formula action enables you to set the formula of a specified cell in a worksheet.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Select the Active cell, Specific cell, or Mutliple cell option to specify the cell in which to set the

formula. If you have selected the Specific cell option, specify the address of the cell in the Cell name
field. For the multiple cell option, specify a cell range.

• Enter the value to set in the Cell formula field, without an "=".

Column/Row operations in Office 365 Excel
The Office 365 Excel package contains actions that you can use to automate tasks related to column and
row operations such as autofit, delete, insert, and read.
The Office 365 Excel package includes the following actions:

Actions Descrizione

Adatta colonne automaticamente Consulta Autofit columns action in Office 365 Excel
alla pagina 1717.

Adatta righe Consulta Autofit rows action in Office 365 Excel alla
pagina 1718.

Elimina riga o colonna Consulta Using Delete action for rows or columns
alla pagina 1718.

Ottieni conteggio riga Consulta Get row count action in Office 365 Excel
alla pagina 1718.

Inserisci riga o colonna Consulta Using Insert action for rows or columns
alla pagina 1719.

Leggi colonna Consulta Read column action in Office 365 Excel
alla pagina 1719.

Leggi riga Consulta Read row action in Office 365 Excel alla
pagina 1719.

Autofit columns action in Office 365 Excel
Use the Autofit columns action in the Office 365 Excel package to adjust (automatically fit) the width of
columns in a worksheet in a specified session.

Impostazioni

Enter the name of the session used to open the workbook with the Open .
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Autofit rows action in Office 365 Excel
Use the Autofit rows action in the Office 365 Excel package to adjust (automatically fit) the height of the
rows in a worksheet in a specified session.

Impostazioni

Enter the name of the session used to open the workbook with the Open .
Using Delete action for rows or columns
Use the Delete action to remove rows or columns from the current worksheet.
To delete rows or columns in a worksheet, do the following:
1. Double-click or drag Office 365 Excel > Delete.
2. Enter the name of the session used to open the workbook with the Open .
3. Seleziona una delle seguenti:

• Operazioni righe
a. Select the Delete Row(s) at option to delete all of the cells in a specific row. Specify the row

number to delete in the field. For example, to delete the tenth row in the worksheet, enter 10
in the field.

b. Select the Delete Row(s) by option to delete all of the cells in either:
• the row of the active cell.
• a specific range of cells. Specify the range to delete. For example, to delete the first five

rows, enter 1:5 in the field.

• Operazioni colonne
a. Select the Delete Column(s) at option to delete all of the cells in a specific column. Specify

the address of the column to delete in the field. For example, to delete column 'D' in the
worksheet, enter D in the field.

b. Select the Delete Columns(s) by option to delete all of the cells in either:
• the column of the active cell.
• a specific range of cells. Specify the range to delete. For example, to delete the first five

columns, enter A:E in the field.

4. Fai clic su Salva.

Get row count action in Office 365 Excel
Use the Get row count action in the Office 365 Excel package to retrieve the number of rows that contain
data in a worksheet.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Assign the output value to a Number variable.

To convert the variable to a String variable, use the Number > To string action. Per ulteriori
informazioni, consulta To string action in Number alla pagina 1696.
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Using Insert action for rows or columns
Use the Insert action to create rows or columns in the current worksheet.
To insert or delete rows or columns in a worksheet, do the following:
1. Double-click or drag Office 365 Excel > Insert.
2. Enter the name of the session used to open the workbook with the Open .
3. Seleziona una delle seguenti:

• Operazioni righe
a. Select the Insert Row(s) at option to insert a row and specify the location where to insert

the row in the field. For example, to insert a row of cells in the tenth row in the worksheet,
enter 10 in the field.

b. Select the Insert Row(s) by option to insert all of the cells in either:
• the row of the active cell.
• a specific range of cells. Specify the range where to insert the row. For example, to insert a

row of cells in the first five rows in the worksheet, enter 1:5 in the field.

• Operazioni colonne
a. Select the Insert Column(s) at option to insert a column and specify the location where

to insert the row in the field. For example, to insert a column of cells in column 'D' in the
worksheet, enter D in the field.

b. Select the Insert Columns(s) by option to insert all of the cells in either:
• the column of the active cell.
• a specific range of cells. Specify the range to insert the column. For example, to insert a

row of cells in the first five columns, enter A:E in the field.

4. Fai clic su Salva.

Read column action in Office 365 Excel
Use the Read column action in the Office 365 Excel package to extract data from a column and store it in a
List variable.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Select the cell option as Active cell or Specific cell to specify the starting point.
• Puoi anche selezionare l'opzione Leggi colonna intera per estrarre i dati per l'intera colonna.
• Assign the output value to a List variable.

Read row action in Office 365 Excel
Use the Read row action in the Office 365 Excel package to extract data from a row and store it in a
variable.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Select the cell option as Active cell or Specific cell to specify the starting point.
• Puoi anche selezionare l'opzione Leggi riga intera per estrarre i dati per l'intera riga.
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• Assign the output to a variable: Multiple variables or a Record variable.

Table operations in Office 365 Excel
The Office 365 Excel package contains various actions that you can use to automate tasks related to the
table operations such as create, delete, filter, get properties, rename, and sort.
The Office 365 Excel package includes the following actions:

Actions Descrizione

Crea tabella Consulta Create table action in Office 365 Excel alla
pagina 1720.

Elimina tabella Consulta Delete table action in Office 365 Excel alla
pagina 1720.

Ottieni colonna tabella Consulta Get table column action in Office 365 Excel
alla pagina 1720.

Ottieni nomi tabelle Consulta Get table names action in Office 365 Excel
alla pagina 1721.

Ottieni riga tabella Consulta Get table row action in Office 365 Excel
alla pagina 1721.

Ottieni conteggio righe tabella Consulta Get table row count action in Office 365
Excel alla pagina 1721.

Rinomina tabella Consulta Rename table action in Office 365 Excel
alla pagina 1721.

Create table action in Office 365 Excel
The Create table action in the Office 365 Excel package enables you to create a new table in the specified
table range.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Enter the table name.
• Enter the cell range in which to create the table. For example, A1:D4.
• Facoltativo: Select the Table has headers option to establish the first row as the header row.

Delete table action in Office 365 Excel
The Delete table action in the Office 365 Excel package enables you to delete a table in the active
worksheet.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Enter the table name that has to be deleted.

Get table column action in Office 365 Excel
Use the Get table column action in the Office 365 Excel package to retrieve the column values of a
specified table and column index, and assign the values to a List variable.
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Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Enter the table name.
• Enter the column index. For example, enter 5 to indicate the fifth column from the left.
• Select a List variable to store the values.

Get table names action in Office 365 Excel
The Get table names action in Office 365 Excel enables you to retrieve the names of all the tables in a
workbook and assign them to a List variable.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Facoltativo: Select whether to specify a sheet either by index or name.
• Select a List variable to store the values.

Get table row action in Office 365 Excel
The Get table row action in Office 365 Excel enables you to retrieve the row values of a specified table and
row index, and assign the values to a variable.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Enter the table name.
• Enter the row index. For example, enter 5 to indicate the fifth row from the top.
• Assign the output to a variable: Multiple variables or a Record variable.

Get table row count action in Office 365 Excel
The Get table row count action in Office 365 Excel enables you to retrieve the row count of a specified
table and assign the values to a number variable.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Enter the table name.
• Select a Number type variable to store the values.

To convert the variable to a String variable, use the Number > To string action. For more information,
see To string action in Number alla pagina 1696 .

Rename table action in Office 365 Excel
The Rename table action in Office 365 Excel enables you to rename a table.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Enter the current or existing table name.
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• Enter a new table name.

Workbook operations in Office 365 Excel
The Office 365 Excel package contains enables you to automate opening, closing, or creating a new
workbook.
The Office 365 Excel package includes the following actions:

Actions Descrizione

Chiudi See Close action.

Crea cartella di
lavoro

See Create workbook action.

Apri Consulta Using the Open action alla pagina 1722.

Close action in Office 365 Excel
Use the Close action in Office 365 Excel package to close a workbook.

Impostazioni

Enter the name of the session used to open the workbook with the Open .
Create workbook action in Office 365 Excel
Use the Create workbook action in Office 365 Excel package when you want to create a new workbook.

Impostazioni

• Enter Enter the name of the session used to open the workbook with the Open .
• Provide a File Path containing the new workbook name with one of the following

extensions: .xls, .xlsm, .xlsx.
Either enter the file path or select a String variable. For example, to perform this action on a file named
SalesReport.xlxs, located in the Accounts folder, enter Accounts/SalesReport.xlxs.

Using the Open action
Use this action to open a workbook. Insert this action at the start of your automation sequences.
To open a workbook, do the following:
1. Double-click or drag the Open action.
2. Provide the username either by selecting a Credential variable or entering an unencrypted value.
3. Enter a Session name.

Use this same session name in subsequent actions to associate them with this workbook.
4. Enter the File Path or insert a file variable.

For example, to perform this action on a file named SalesReport.xlxs, located in the Accounts
folder, enter the file name SalesReport.xlxs.

Nota:  Ensure that the Microsoft Excel file is placed in the My Files folder in OneDrive.

5. If the sheet contains a header row, mark the Sheet contains header option.
6. Fai clic su Salva.
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Worksheet operations in Office 365 Excel
The Office 365 Excel package contains actions that you can use to automate tasks related to worksheet
operations, such as delete, find, get worksheet names, hide, retrieve worksheet count, and show.
The Office 365 Excel package includes the following actions:

Actions Descrizione

Copia foglio di lavoro Consulta Using the Copy worksheet action alla
pagina 1723.

Crea foglio Consulta Create sheet action in Office 365 Excel alla
pagina 1724.

Elimina foglio di lavoro Consulta Delete worksheet action in Office 365 Excel
alla pagina 1724.

Ottieni nome foglio di lavoro corrente Consulta Get current worksheet name action in
Office 365 Excel alla pagina 1724.

Ottieni nome fogli di lavoro Consulta Get worksheet names action in Office 365
Excel alla pagina 1724.

Nascondi foglio di lavoro Consulta Hide worksheet action in Office 365 Excel
alla pagina 1725.

Rinomina foglio di lavoro Consulta Rename worksheet action in Office 365
Excel alla pagina 1725.

Recupera conteggio dei fogli Consulta Retrieve sheet count action in Office 365
Excel alla pagina 1725.

Mostra foglio di lavoro Consulta Show worksheet action in Office 365 Excel
alla pagina 1725.

Passa al foglio Consulta Switch to sheet action in Office 365 Excel
alla pagina 1726.

Using the Copy worksheet action
Use the Copy worksheet action to copy values of a worksheet from one worksheet to another. This
action overwrites any existing values. To move values from one worksheet to another without overwriting
existing values, use the Append worksheet action.
Open the workbook(s) containing the source and target worksheets. Consulta Using the Open action alla
pagina 1722.

Nota:  This action identifies the destination and source workbooks by the session names used to open
them. If opening two workbooks, enter a session name for the source workbook that is different than the
one used to open the destination workbook.

To copy the values of a worksheet into another, do the following:
1. Double-click or drag the Copy worksheet action.
2. Enter the name of the session that you used to open the destination workbook in the Open action.
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3. If the workbook contains more than one worksheet, mark the Specific Sheet option, then enter the
index number or name of the source worksheet.
• The index number represents the position of the worksheet in the workbook. For example, to

perform an operation on the worksheet at the third position in the workbook, enter 3 in the field.
• The sheet name field is case insensitive.

4. Enter the name of the session that you used to open the source workbook in the Open action.
5. If the workbook contains more than one worksheet, mark the Specific Sheet option, then enter the

index number or name of the destination worksheet.
6. Fai clic su Salva.

Create sheet action in Office 365 Excel
The Create sheet action in the Office 365 Excel package enables you to add an empty sheet in the
current workbook.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Enter a Worksheet name of up to 31 characters. The name cannot contain the following characters:

\ / ? * [ ]

Delete worksheet action in Office 365 Excel
The Delete worksheet action in the Office 365 Excel package enables you to delete a spreadsheet from
the current workbook.

Impostazioni

• Enter the name of the session used to open the workbook with the Open .
• Specifica un numero indice nel campo Foglio per indice o un nome per il foglio di lavoro nel campo

Foglio per nome. The index number is the number assigned to a worksheet. For example, if you want
to perform an operation on the worksheet at the third position in the workbook, enter 3 in the field.

Nota:  Puoi eliminare un foglio di lavoro solo se la cartella di lavoro ne contiene più di uno.

Get current worksheet name action in Office 365 Excel
The Get current worksheet name action in the Office 365 Excel package enables you to retrieve the
name of the currently active worksheet.

Impostazioni

• Enter the name of the session used to open the workbook with the Open .
• Select a string variable that you want to use to store the name of the worksheet from the Assign the

output to variable list. La  mostra un nome descrittivo predefinito della variabile. If you create several
output variables, subsequent variable names are appended with a -1, -2, -3, and so on to avoid
duplication.

Get worksheet names action in Office 365 Excel
The Get worksheet names action in the Office 365 Excel package enables you to retrieve the names of
all the worksheets in the workbook.
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Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Select a list variable to store the worksheet names from the Assign the output to variable list.

Hide worksheet action in Office 365 Excel
The Hide worksheet action in the Office 365 Excel package enables you to hide a worksheet from the
current workbook.

Impostazioni

• Specifica il nome del foglio di lavoro da nascondere nel campo Inserisci il nome del foglio di lavoro
da nascondere.

Nota:  Puoi nascondere un foglio di lavoro solo se la cartella di lavoro ne contiene più di uno.

• Enter the name of the session used to open the workbook with the Open .

Rename worksheet action in Office 365 Excel
The Rename worksheet action in the Office 365 Excel package enables you to rename a worksheet in
the current workbook.

Impostazioni

• Specifica il numero indice o il nome del foglio di lavoro da eliminare nel campo Foglio per indice o
Foglio per nome.
Il numero indice è il numero assegnato a un foglio di lavoro. Ad esempio, se desideri eseguire
un'operazione sul foglio di lavoro nella terza posizione della cartella di lavoro, inserisci 3 nel campo.

Nota:  Non puoi rinominare il foglio di lavoro se esiste già un foglio di lavoro con lo stesso nome nella
cartella di lavoro.

• Inserisci un nuovo nome del foglio di lavoro che sia inferiore a 31 caratteri.
• Enter the name of the session used to open the workbook with the Open .

Retrieve sheet count action in Office 365 Excel
The Retrieve sheet count action in the Office 365 Excel package enables you to get the number of
sheets available in the current workbook and stores it in a number variable.

Impostazioni

• Seleziona l'opzione appropriata per specificare se includere o meno il foglio di lavoro nascosto e
assegna il conteggio a una variabile.

• Enter the name of the session used to open the workbook with the Open .
• Select a number variable that you want to use to store the name of the worksheet from the Select

the variable to assign to list. La  mostra un nome descrittivo predefinito della variabile. If you create
several output variables, subsequent variable names are appended with a -1, -2, -3, and so on to
avoid duplication.

Show worksheet action in Office 365 Excel
The Show worksheet action in the Office 365 Excel package enables you to show the hidden worksheet.
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Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Enter the Worksheet name.

Switch to sheet action in Office 365 Excel
The Switch to sheet action in the Office 365 Excel package enables you to activate a particular sheet in a
Microsoft Excel file.

Impostazioni

• Enter the name of the session used to open the workbook with the Open action.
• Specifica se attivare Foglio per indice (valore numerico) o Foglio per nome.

Office 365 One Drive package
The One Drive package contains actions that enable you to automate many of the repetitive tasks in
Microsoft cloud storage.

How to use the actions in the One Drive package

Perform the following actions within the One Drive package as part of using the set of available actions:
1. Use the Connect action to establish a connection to the Office 365 server.

Consulta Using Connect action for Office 365 packages alla pagina 1705.

Nota:  Office 365 packages do not currently support Multi-Factor Authentication or Single Sign-on.

2. Use a combination of actions available in this package to automate tasks.

Nota:  To use actions from other Office 365 packages, establish a connection using the Connect
action from that package.

3. Utilizza l'action Disconnetti per terminare la connessione.

For an example on how to setup and connect to the Office 365 OneDrive package, see Working with the
Office 365 OneDrive package.

Actions in the One Drive package
Use the actions in the One Drive package to perform an operation on a single file or folder. To perform
the operation on every file in a folder, use that action in a loop. Consulta Using One Drive actions in a loop
alla pagina 1727.

Nota:  Automation 360 supports the shared drive. To use shared drive items such as a file or folder, you
should provide the link and name of that file or folder.

The One Drive package includes the following actions:
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Action Descrizione

Verifica autorizzazione Check permission action alla pagina 1728

Connetti Establishes a connection with the Office 365
server using your organization's client ID and
tenant ID, and user credentials.
Consulta Using Connect action for Office 365
packages alla pagina 1705.

Copia file o cartella Copy file or folder action alla pagina 1728

Create folder Create folder action alla pagina 1729

Elimina file o cartella Delete file or folder action alla pagina 1729

Disconnetti Disconnect action for Office 365 packages alla
pagina 1708

Scarica file Download file action alla pagina 1729

Esporta come PDF Export to PDF action alla pagina 1730

Trova file e cartelle Find files and folders action alla pagina 1730

Ottieni informazioni su file o cartella Get file or folder information action alla pagina
1730

Sposta file o cartella Move file or folder action alla pagina 1731

Rinomina file o cartella Rename file or folder action alla pagina 1731

Ripristina ultima versione Restore last version action alla pagina 1731

Carica file Upload file action alla pagina 1732

Using One Drive actions in a loop
Use the Find files and folder action to return a table of files and their properties inside of a specified
folder, the Loop action to loop through each row in the table, and a One Drive action to perform an
operation on every file in the table.
To perform an action on every file in a folder, do the following steps:
1. Double-click or drag One Drive > Find files and folders.
2. Provide your username with either a credential variable or an unencrypted value.
3. Enter the file path of the folder in which to perform the search.
4. Select the All items in folder option.

You can alternatively select Specific file (or folder) to limit the search to a specific folder on your
OneDrive.

5. Seleziona o crea una variabile tabella per mantenere l'output.
The table variable holds information on files and folders in rows, under the following columns: name,
id, createdBy, creationDate, lastModifiedBy, lastModificationDateTime, parentFolder, and Path.

6. Fai doppio clic o trascina l'action Loop.
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7. Select the For each row in table iterator.
8. Select the table variable holding the output from step 5.
9. Select or create a record variable to temporarily hold each row.
Insert the action inside of the Loop container that you want to repeat on every file in the folder. This
example uses the Download file action.
10. Double-click or drag Outlook > Download file.
11. Provide your username with either a credential variable or an unencrypted value.
12. Enter the following in the File name including path field, replacing the generic variable names with

the names of the record variables from step 10:
$RecordVariable[7]$/$RecordVariable[0]$

13. Enter the path to the folder where to download the files.
14. Fai clic su Salva.

Check permission action
The Check permission action in the Office 365 OneDrive package checks for read and write permission for
a file or folder in your OneDrive.

Impostazioni

• Enter the Office 365 user session that you provided in the Connect action.
• Provide the file or folder name for which to check permissions.
• Specify which permission type to verify: Read or Read & Write.
• Select a predefined Boolean type variable to hold the output, or click the icon on the right to create a

new variable.
The Boolean type variable will provide a true (user has permission) or false (user does not have
permission) response.

Copy file or folder action
The Copy file or folder action in the Office 365 OneDrive package duplicates a file or folder from one folder
to another in your OneDrive.

Impostazioni

• Enter the user session that you provided in the Connect .
• Select whether to copy a file or folder.
• Provide the source and destination file/folder names and paths or file/folder link.

To obtain the file or folder link, copy the link generated from Share OneDrive files and folders

For example, to perform this action on a file named SalesReport.xlxs, located in the Accounts folder,
enter /Accounts/SalesReport.xlxs.

Nota:  The forward slash that indicates that a file or folder is located in the root directory is optional.

• Facoltativo: If there is file or folder with the same name in the destination folder, select the Override
existing file/folder option which replaces the existing file or folder with the one being copied.
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Create folder action
The Create folder action in the Office 365 OneDrive package creates a new folder in a specific directory in
your OneDrive.

Impostazioni

• Enter the user session that you provided in the Connect .
• Enter the parent folder name and path, or folder link.

To obtain the folder link, copy the link generated from Share OneDrive files and folders

For example, to perform this action on a folder named Q1, located in the Survey Results folder, enter /
Survey Results/Q1.

• Immetti il nuovo nome della cartella.

Delete file or folder action
The Delete file or folder action in the Office 365 OneDrive package removes a file or folder from a specific
directory in your OneDrive.

Impostazioni

• Enter the user session that you provided in the Connect .
• Select whether to delete a file or folder.
• Provide the name and path, or file or folder link.

To obtain the file or folder link, copy the link generated from
For example, to perform this  on a file named SalesReport.xlxs, located in the Accounts folder, enter /
Accounts/SalesReport.xlxs.

Nota:  The forward slash that indicates that a file or folder is located in the root directory is optional.

Download file action
The Download file action in the Office 365 OneDrive package downloads a file from a specific directory in
your OneDrive.

Impostazioni

• Enter the user session that you provided in the Connect .
• Provide the file name and path, or file link.

To obtain the file link, copy the link generated from Share OneDrive files and folders

For example, to perform this  on a file named SalesReport.xlxs, located in the Accounts folder, enter /
Accounts/SalesReport.xlxs.

Nota:  The forward slash that indicates that a file or folder is located in the root directory is optional.

• Enter the destination folder path on the local device.
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• Facoltativo: If there is file or folder with the same name in the destination folder, select the Override
existing file/folder option which replaces the existing file or folder with the one being copied.

Export to PDF action
The Export to PDF action in the Office 365 OneDrive package exports an existing file in your OneDrive to
a PDF on your device. This action supports the following file extensions: doc, docx, oentry, odp, pps, ppt,
pptx, tf, xls, and xlsx.

Impostazioni

• Enter the user session that you provided in the Connect .
• Provide the file name and path, or file link. Either enter the values or insert a predefined string variable.

To obtain the file link, copy the link generated from Share OneDrive files and folders

For example, to perform this  on a file named SalesReport.xlxs, located in the Accounts folder, enter /
Accounts/SalesReport.xlxs.

Nota:  The forward slash that indicates that a file or folder is located in the root directory is optional.

• Enter the export folder name and path or select a predefined string variable.
• Facoltativo: If there is file or folder with the same name in the destination folder, select the Override

existing file/folder option which replaces the existing file or folder with the one being copied.

Find files and folders action
The Find files and folders action in the Office 365 OneDrive package returns a table of files and folders in a
specific directory in your OneDrive.

Impostazioni

• Enter the user session that you provided in the Connect .
• Provide directory details in the Folder to search field: enter the folder name and path, or folder link.

To obtain the folder link, copy the link generated from
For example, to perform this  on a folder named Q1, located in the Survey Results folder, enter /
Survey Results/Q1.

• Specify whether to search for All items in folder or a Specific file (or folder).

Nota:  The Drive Item Name field accepts wildcard characters in the file name and extension. For
example, to search for all documents with extension docx, enter *.docx in the Specific file (or
folder) field.

• Assign the output to a table variable.
The variable will hold the following file or folder details: Name, ID, CreatedBy, CreationDate,
LastModifiedBy, LastModificationDate, and ParentFolderPath.

Get file or folder information action
The Get file or folder information action in the Office 365 OneDrive package retrieves information for a
specific file or folder from OneDrive.
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Impostazioni

• Enter the user session that you provided in the Connect .
• Provide the file or folder name and path, or file/folder link.

To obtain the file or folder link, copy the link generated from
For example, to perform this  on a file named SalesReport.xlxs, located in the Accounts folder, enter /
Accounts/SalesReport.xlxs.

Nota:  The forward slash that indicates that a file or folder is located in the root directory is optional.

• Assign the output to a record variable.
The variable will hold the following file or folder details: Name, ID, CreatedBy, CreationDate,
LastModifiedBy, LastModificationDate, and ParentFolderPath.

Move file or folder action
The Move file or folder action in the Office 365 OneDrive package moves a file or folder from one folder to
another in OneDrive.

Impostazioni

• Enter the user session that you provided in the Connect .
• Select whether to move a file or folder.
• Provide the source and destination file or folder names and paths, or file/folder links.

To obtain the file or folder link, copy the link generated from
For example, to perform this  on a file named SalesReport.xlxs, located in the Accounts folder, enter /
Accounts/SalesReport.xlxs.

Nota:  The forward slash that indicates that a file or folder is located in the root directory is optional.

• Facoltativo: If there is file or folder with the same name in the destination folder, select the Override
existing file/folder option which replaces the existing file or folder with the one being copied.

Rename file or folder action
The Rename file or folder action in the Office 365 OneDrive package renames a file or folder in a specific
directory in OneDrive.

Impostazioni

• Enter the user session that you provided in the Connect .
• Select whether to rename a file or folder.
• Provide the current and new file or folder names, or file/folder link.
• To obtain the file or folder link, copy the link generated from
• Facoltativo: If there is file or folder with the same name in the destination folder, select the Override

existing file/folder option which replaces the existing file or folder with the one being copied.

Restore last version action
The Restore last version action in the Office 365 OneDrive package restores a file to the last version.
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Impostazioni

• Enter the user session that you provided in the Connect .
• Provide the file name and path, or file link.

To obtain the file or folder link, copy the link generated from
For example, to perform this  on a file named SalesReport.xlxs, located in the Accounts folder, enter /
Accounts/SalesReport.xlxs.

Nota:  The forward slash that indicates that a file or folder is located in the root directory is optional.

Upload file action
The Upload file action in the Office 365 OneDrive package uploads a file to a specific directory in OneDrive.

Impostazioni

• Enter the user session that you provided in the Connect .
• Provide the file name and path on the local directory.

For example, D:/Mydata/HR/EmployeeSurvey.xlsx.
• Provide the upload folder name and path, or folder link.

To obtain the folder link, copy the link generated from
For example, to perform this action on a folder named Q1, located in the Survey Results folder in home
directory, enter /Survey Results/Q1

Nota:  You cannot provide the private folder path from one drive as it is not supported.

• Facoltativo: If there is file or folder with the same name in the destination folder, select the Override
existing file/folder option which replaces the existing file or folder with the one being copied.

PDF package
Use the PDF package to automate various operations on a PDF file.
Il package PDF consente di eseguire le seguenti attività:
• Encrypt or decrypt a PDF file.
• Extract text from a PDF file.
• Convert a PDF file to an image.
• Merge several PDF files into a single file.
• Split a single PDF file into multiple files.

It is not necessary to have a PDF reader installed on your device.

Actions nel package PDF

Il package PDF include le seguenti actions:
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Nota:  The Extract field, Extract image, and Extract text actions in the PDF package are supported only for
PDF files that are editable. These packages are not supported for scanned PDF documents that contain the
PDF content as images.

Action Descrizione

Decodifica documento Consulta Using the Decrypt document action alla pagina 1737.

Codifica documento Consulta Using the Encrypt document action alla pagina 1733.

Estrai campo Vedi Using the Extract field action alla pagina 1734

Estrai immagine Consulta Using the Extract image action alla pagina 1736.

Estrai testo Consulta Using Extract text action from PDF alla pagina 1735.

Ottieni proprietà Vedi Using the Get property action alla pagina 1738

Unisci documenti Consulta Using the Merge documents action alla pagina 1738.

Dividi documento Consulta Using the Split document action alla pagina 1739.

When an operation is performed on a PDF file, the file properties are stored in a dictionary variable.
Consulta Using a dictionary variable for PDF properties alla pagina 1740.

Using the Encrypt document action
Use the Encrypt document action to encrypt a PDF file.
To encrypt a PDF file, follow these steps:
1. In the Actions palette, double-click or drag the Encrypt document action from the PDF package.
2. In the PDF path, select one of the following options to specify the location of the PDF:

• File Control Room: Enables you to select a PDF file that is available in a folder in the Control
Room.

• Profilo desktop: Enables you to select a PDF file that is available on your device.
• Variabile: Enables you to specify the file variable that contains the location of the PDF file.

3. Opzionale: In the User password or Owner password field, enter a password to restrict access to
the encrypted PDF file.
• User password: Allow users to perform specific operations on the encrypted PDF file.
• Owner password: Allow users to use a password to open the file.

4. In the User Permissions to Apply field, select the following operations:
• Print: Allows users to print the document.
• Modify: Allows users to edit the document.
• Copy: Allows users to copy the document.
• Form Fill: Allows users to fill a form in the document.
• Document Assembly: Allows users to combine multiple PDF files, attach files, and so on.
• Annotation: Allows users to apply annotations in the document.
• Accessibility: Allows users to read text from the document using accessibility devices.

5. In the Encryption level, select the RC4 40-bit, RC4 128-bit, or AES 128-bit option to specify the
encryption level.
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6. In the Save encrypted PDF as field, specify a name and location for the encrypted file.
You must include the .pdf extension in the name of the encrypted file. For example, if the file name is
June_Quarter_report, the .pdf extension is June_Quarter_report.pdf.

7. Select the Overwrite files with the same name check box to overwrite existing files with the same
name.

Nota:  If this option is not selected and the bot encounters a file with the same name at the specified
location, the bot will fail.

8. Opzionale: From the Assign PDF properties to a dictionary variable list, select a dictionary
variable to hold the file properties.
Per ulteriori informazioni, consulta Using a dictionary variable for PDF properties alla pagina 1740.

9. Fai clic su Salva.

Attività correlate
Using the Decrypt document action alla pagina 1737
Use the Decrypt document action to decrypt a PDF file that was previously encrypted using the Encrypt
document action.

Using the Extract field action
Utilizza l'azione Estrai campo per estrarre i campi da un PDF e assegnarli alle variabili.

Importante:  When you extract fields from a PDF that contains 20 form fields, processing time might be
30 to 40 % longer than PDFs without form fields.

To extract fields from a PDF file, follow these steps:
1. Nella tavolozza Actions, fai doppio clic o trascina l'Estrai campo action dal PDF package.
2. In the PDF path, select one of the following options to specify the location of the PDF:

• File Control Room: Enables you to select a PDF file that is available in a folder in the Control
Room.

• Profilo desktop: Enables you to select a PDF file that is available on your device.
• Variabile: Enables you to specify the file variable that contains the location of the PDF file.

3. From the File is protected field, select Yes if the file is encrypted and provide the User password
or Owner password.

4. Fai clic su Apri visualizzatore PDF.
5. In the Select a PDF file window, select a PDF file from Control Room file or Desktop file.
6. Opzionale: Enter the password.
7. Fai clic su Carica per aprire il Visualizzatore PDF.

Nella finestra Visualizzatore PDF, il PDF viene aperto con tutti i campi strutturati evidenziati in
rettangoli a puntini viola.

8. Select the rectangular area of the field to be extracted and click Add field to add the field and its
value under the Extract fields table.

9. Opzionale: You can add an unstructured field that are not highlighted in the PDF. Select the Draw a
region option available at the top of the PDF viewer and draw a rectangle box around the required
region.
Un rettangolo punteggiato di colore rosso viene evidenziato con l'opzione Aggiungi regione
personalizzata

10. Fai clic su Aggiungi regione personalizzata per visualizzare le coordinate acquisite nella finestra
Regione personalizzata. Inserisci il Nome della chiave che può essere utilizzato nella variabile di
output.
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11. Click Close to add the field in the Extract fields table.
L'elenco dei campi estratti viene visualizzato nella tabella Estrai campi nel pannello destro della
finestra del Visualizzatore PDF.
I campi estratti diventano rettangoli a puntini blu nel visualizzatore PDF. È possibile modificare i campi
estratti selezionando il rettangolo blu attorno al campo.
Utilizza il pulsante ellittico verticale accanto al campo estratto nella tabella Estrai campi per
Modificare, Spostare o Eliminare il campo.

12. Fai clic su Chiudi per chiudere il visualizzatore PDF.
13. Dal campo Salva l'output in una variabile, scegli una o più variabili del dizionario per contenere i

valori del campo.
14. Fai clic su Salva.

Using Extract text action from PDF
Estrai il testo da un file PDF e salvalo come file di testo utilizzando l'action Estrai testo.

Importante:  Se i font corretti non sono incorporati nel file PDF, l'action Estrai testo non estrae il testo
correttamente.

Nota:  When you extract fields from a PDF that contains 20 form fields, processing time might be 30 to 40
% longer than PDFs without form fields.

Per estrarre il testo da un file PDF, attieniti alla seguente procedura:
1. Nella tavolozza Actions, fai doppio clic o trascina l'action Estrai campo dal package PDF.
2. In the PDF path, select one of the following options to specify the location of the PDF:

• File Control Room: Enables you to select a PDF file that is available in a folder in the Control
Room.

• Profilo desktop: Enables you to select a PDF file that is available on your device.
• Variabile: Enables you to specify the file variable that contains the location of the PDF file.

3. Opzionale: In the User password or Owner password field, enter a password to restrict access to
the encrypted PDF file.
• User password: Allow users to perform specific operations on the encrypted PDF file.
• Owner password: Allow users to use a password to open the file.

4. Nel campo Tipo di testo, seleziona una delle seguenti opzioni:
• Testo semplice: estrai il testo e copialo in un file di testo.

È un'operazione simile al copia e incolla di testo da un file PDF in un file di testo.
• Testo strutturato: conserva la formattazione originale del testo estratto dal file PDF.

Puoi selezionare l'opzione Riduci perdita dati per garantire l'estrazione del testo completo con
una sovrapposizione di caratteri minima. Con questa funzionalità, si riduce il numero di caratteri
sovrapposti ad altri caratteri.

Nota:  Quando selezioni questa opzione per estrarre il testo, il testo estratto potrebbe contenere
caratteri di spazio extra.

5. In the Page range field, select one of the following options:
• All pages: Enables you to save all the pages in the PDF file as an image.
• Pages: Enables you to enter the page numbers of the pages that you want to save as an image.
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6. Nel campo Esporta dati in file di testo, specifica un nome e una posizione per il file di testo.

Nota:  Devi includere l'estensione .txt nel nome del file di testo. Ad esempio, se il nome del file è
report_trimestrale_giugno, l'estensione .txt è report_trimestrale_giugno.txt.

7. Select the Overwrite files with the same name check box to overwrite existing files with the same
name.

Nota:  If this option is not selected and the bot encounters a file with the same name at the specified
location, the bot will fail.

8. Opzionale: From the Assign PDF properties to a dictionary variable list, select a dictionary
variable to hold the file properties.
Per ulteriori informazioni, consulta Using a dictionary variable for PDF properties alla pagina 1740.

9. Fai clic su Salva.

Using the Extract image action
Use the Using Extract image action to save a PDF file as an image.
To save a PDF file as an image, follow these steps:
1. In the Actions palette, double-click or drag the Extract image action from the PDF package.
2. In the PDF path, select one of the following options to specify the location of the PDF:

• File Control Room: Enables you to select a PDF file that is available in a folder in the Control
Room.

• Profilo desktop: Enables you to select a PDF file that is available on your device.
• Variabile: Enables you to specify the file variable that contains the location of the PDF file.

3. Opzionale: In the User password or Owner password field, enter a password to restrict access to
the encrypted PDF file.
• User password: Allow users to perform specific operations on the encrypted PDF file.
• Owner password: Allow users to use a password to open the file.

4. In the Page range field, select one of the following options:
• All pages: Enables you to save all the pages in the PDF file as an image.
• Pages: Enables you to enter the page numbers of the pages that you want to save as an image.

5. In the Type of image to be converted to list, select one of the following options to specify the
format:
• TIFF: If you selected this option, select an option from the TIFF compression type list.

• NONE
• LZE
• RLE
• CCITT Group 3
• CCITT Group 4

• BMP
• JPEG: If you selected this option, in the JPEG quality field, enter a value (between 0 and 100) to

specify the quality of the compressed image.
• GIF
• PNG
• WMF
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• EMF
• EXIF

6. In the Folder path field, specify the location.
7. In the File prefix field, enter a value.

The image files are suffixed with index numbers. For example, if you have specified Report as the
File prefix, the name of the image files will be Report_1, Report_2, and so on.

8. Select the Overwrite files with the same name check box to overwrite existing files with the same
name.

Nota:  If this option is not selected and the bot encounters a file with the same name at the specified
location, the bot will fail.

9. In the X Resolution (dpi) and Y Resolution (dpi) fields, specify the resolution.
10. In the Image output field, choose Color or Grayscale to specify the image output type:

a) In the Color property list, select an option.
• True color (32 bits)
• True color (24 bits)
• High color (16 bits)
• 56 color (8 bits)
• 16 color (4 bits)
• 2 color (1 bit, black/white)

Nota:  This option is available only with the Color image output type. Select this option only
if RLE, CCITT Group 3, or CCITT Group 4 compression type is selected for the TIFF image
format.

11. Opzionale: From the Assign PDF properties to a dictionary variable list, select a dictionary
variable to hold the file properties.
Per ulteriori informazioni, consulta Using a dictionary variable for PDF properties alla pagina 1740.

12. Fai clic su Salva.

Using the Decrypt document action
Use the Decrypt document action to decrypt a PDF file that was previously encrypted using the Encrypt
document action.
To decrypt an encrypted PDF file, follow these steps:
1. In the Actions palette, double-click or drag the Decrypt document action from the PDF package.
2. In the PDF path, select one of the following options to specify the location of the PDF:

• File Control Room: Enables you to select a PDF file that is available in a folder in the Control
Room.

• Profilo desktop: Enables you to select a PDF file that is available on your device.
• Variabile: Enables you to specify the file variable that contains the location of the PDF file.

3. Opzionale: In the User/Owner password field, enter a password to restrict access to the decrypted
PDF file.

4. In the Save the decrypted PDF file as field, specify a name and location for the decrypted file.
You must include the .pdf extension in the name of the decrypted file. For example, if the file name is
June_Quarter_report, the .pdf extension is June_Quarter_report.pdf.
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5. Select the Overwrite files with the same name check box to overwrite existing files with the same
name.

Nota:  If this option is not selected and the bot encounters a file with the same name at the specified
location, the bot will fail.

6. Opzionale: From the Assign PDF properties to a dictionary variable list, select a dictionary
variable to hold the file properties.
Per ulteriori informazioni, consulta Using a dictionary variable for PDF properties alla pagina 1740.

7. Fai clic su Salva.

Attività correlate
Using the Encrypt document action alla pagina 1733
Use the Encrypt document action to encrypt a PDF file.

Using the Get property action
Use the Get property action to obtain the properties of the PDF document.
1. In the Actions palette, double-click or drag the Get property action from the PDF package.
2. In the PDF path, select one of the following options to specify the location of the PDF:

• File Control Room: Enables you to select a PDF file that is available in a folder in the Control
Room.

• Profilo desktop: Enables you to select a PDF file that is available on your device.
• Variabile: Enables you to specify the file variable that contains the location of the PDF file.

3. From the File is protected field, select Yes if the file is encrypted and provide the User password
or Owner password.

4. From the Assign PDF properties to a dictionary variable field, choose either a dictionary variable
or multiple variables to hold the field values.
To assign the output to a dictionary variable, map the PDF properties such as File, Author, Title, and
Subject to the corresponding dictionary keys.

5. Fai clic su Salva.

Using the Merge documents action
Use the Merge documents action to merge multiple PDF files into a single PDF file.
1. In the Actions palette, double-click or drag the Merge documents action from the PDF package.
2. Click Add PDF document to provide details on the first PDF file.

The Add PDF document window appears.
3. In the PDF path, select one of the following options to specify the location of the PDF:

• File Control Room: Enables you to select a PDF file that is available in a folder in the Control
Room.

• Profilo desktop: Enables you to select a PDF file that is available on your device.
• Variabile: Enables you to specify the file variable that contains the location of the PDF file.

4. Opzionale: In the User password or Owner password field, enter a password to restrict access to
the encrypted PDF file.
• User password: Allow users to perform specific operations on the encrypted PDF file.
• Owner password: Allow users to use a password to open the file.

5. In the Page range field, select one of the following options:
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• All pages: Selects all the pages in the PDF file.
• Pages: Enter the page numbers of the pages that you want to merge.

Nota:  If you entered 1-3,5-7,8,10 or 10,8,5-7,1-3 in Enterprise 11, the output was pages
1,2,3,5,6,7,8,10. In Automation 360, if you enter the input as follows:
• In ascending order 1-3,5-7,8,10, the output of the pages is 1,2,3,5,6,7,8,10
• In descending order 10,8,5-7,1-3, the output of pages is 10,8,5,6,7,1,2,3

6. Click Yes, Add.
7. Repeat Steps 2 through 6 to provide details on additional PDF files.

To modify the details of, or delete a PDF file, open the actions menu (the vertical ellipsis to the right of
the file).

8. Place the files in the order that they should appear in the merged file.
To move a file, open the actions menu. Then use the Move up or Move down options.

9. In the Output file path field, specify a name and location for the merged file.
You must include the .pdf extension in the name of the decrypted file. For example, if the file name is
June_Quarter_report, the .pdf extension is June_Quarter_report.pdf.

10. Select the Overwrite files with the same name check box to overwrite existing files with the same
name.

Nota:  If this option is not selected and the bot encounters a file with the same name at the specified
location, the bot will fail.

11. Fai clic su Salva.

Using the Split document action
Use the Split document action to split a PDF file into multiple files.
To split a PDF file into multiple files, follow these steps:
1. In the Actions palette, double-click or drag the Split document action from the PDF package.
2. In the PDF path, select one of the following options to specify the location of the PDF:

• File Control Room: Enables you to select a PDF file that is available in a folder in the Control
Room.

• Profilo desktop: Enables you to select a PDF file that is available on your device.
• Variabile: Enables you to specify the file variable that contains the location of the PDF file.

3. Opzionale: In the User password or Owner password field, enter a password to restrict access to
the encrypted PDF file.
• User password: Allow users to perform specific operations on the encrypted PDF file.
• Owner password: Allow users to use a password to open the file.

4. In the Output file creation options, select one of the following options to specify how to split the
PDF file:
• Number of pages per extracted PDF: Enables you to specify the number of pages each new

file will contain. For example, you can enter 8 if you want each output file to contain only 8 pages.
• Single file with selected pages: Enables you to create a single output file that contains the

pages you have specified from the original file.
• Blank page as a separator: Creates a new output file whenever a blank page is encountered in

the original PDF file.
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PDF split separates a blank page from pages with scanned images.
• Bookmark level per file: Enables you to split the PDF file according to the bookmark level

available in the file. For example, if a file contains three bookmark levels, you can split the PDF file
based on these three levels.
If you selected this option, specify the bookmark level in the Bookmark Level field.

5. In the Folder path field, specify the location.
6. In the File prefix field, enter a value.

The image files are suffixed with index numbers. For example, if you have specified Report as the
File prefix, the name of the image files will be Report_1, Report_2, and so on.

7. Select the Overwrite files with the same name check box to overwrite existing files with the same
name.

Nota:  If this option is not selected and the bot encounters a file with the same name at the specified
location, the bot will fail.

8. Opzionale: From the Assign PDF properties to a dictionary variable list, select a dictionary
variable to hold the file properties.
Per ulteriori informazioni, consulta Using a dictionary variable for PDF properties alla pagina 1740.

9. Fai clic su Salva.

Using a dictionary variable for PDF properties
When you automate a PDF-related task, RPA Workspace retrieves various properties of the file and stores
the values of these properties in a dictionary variable.
RPA Workspace retrieves the PDF file name and extension, title, subject, and author. The file properties are
stored in a dictionary variable within the following keys:
• pdfTitle
• pdfFilename
• pdfSubject
• pdfAuthor

The system automatically associates the properties of a PDF with the appropriate dictionary keys.
For example, if you create a dictionary variable Test and want to log the file name and author, you must
enter Test{pdfFilename} and Test{pdfAuthor} in the appropriate fields.

PGP package
Use the PGP (Pretty Good Privacy) package to automatically encrypt and decrypt files for security.
The PGP package supports two types of encryption, symmetric (single key) and asymmetric (pair of keys) :
• PGP symmetric : Requires a single key to encrypt and decrypt files.
• PGP asymmetric: Requires PGP public and private key to encrypt and decrypt files.

Nota:  The system outputs an error when the proper file extension is not present in the path.
• Public key: File name specified for Public Key is not valid.
• Private key: File name specified for Private Key is not valid.
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Actions nel package PGP

Il package PGP include le seguenti actions:

Action Descrizione

Crea chiavi Consulta Create keys action in PGP alla pagina 1741.

Decrittografa i file Decrypts encrypted files. Vedi Using the Decrypt files action alla pagina 1741

Crittografa file Encrypts files to enable users to send them over the internet securely. Vedi
Using the Encrypt files action alla pagina 1741

Create keys action in PGP
Use the Create keys action in the PGP package to create a pair of public and private encryption keys.

Impostazioni

• In the Location to save public key file field, specify the path to the text file where to save the public
key.

• In the Location to save private key file field, specify the path to the text file where to save the
private key.

• In the Password to protect private key file field, select a credential variable or enter a value.
• Select the Overwrite files with the same file name check box to replace files with the same name.

Using the Decrypt files action
Use the Decrypt files action to retrieve the contents of encrypted files and folders.
To decrypt a file or folder, do the following steps:
1. Double-click or drag the Decrypt action from the PGP package.
2. Select either the Passphrase or Public key file encryption type.

• If you have selected Passphrase, enter the value or select a credential variable.
• If you have selected Private key file, provide the private key file path.

Facoltativo: In the Password to protect private key file field, select a credential variable or
enter a value.

3. In the Source folder/file(s) field, specify the folders or files to decrypt.
This field supports wildcard characters in the file name and extension. Use an asterisk (*) to substitute
for one or more unknown alphanumeric characters or symbols.

4. In the Destination folder/file(s) field, specify the location where to save the decrypted folders and
files.
This field supports wildcard characters in the file name and extension. Use an asterisk (*) to substitute
for one or more unknown alphanumeric characters or symbols.

5. Select the Overwrite Files option to replace files with the same name.
6. Select the Remove file extension option and specify the extension name.
7. Fai clic su Salva.

Using the Encrypt files action
Use the Encrypt files action to prepare files and folders to be shared securely.
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To encrypt the files or folder using a public key, create a public-private key pair using the Create keys
action.
To encrypt a file or folder, do the following steps:
1. Double-click or drag the Encrypt action from the PGP package.
2. Select either the Passphrase or Public key file encryption type.

• If you have selected Passphrase, enter the value or select a credential variable.
• If you have selected Public key file, provide the public key file path.

3. Select the Encryption algorithm.
Scegli tra:
• AES128
• AES192
• AES256
• Blowfish
• CAST5
• Idea
• TripleDES
• TwoFish256

4. In the Source folder/file(s) field, specify the folders or files to encrypt.
This field supports wildcard characters in the file name and extension. Use an asterisk (*) to substitute
for one or more unknown alphanumeric characters or symbols.
Ad esempio:
• Enter C:\PGP\encrypt*.csv to select the .csv files that start with the word encrypt.
• Enter C:\PGP\*encrypt*.* to select files of any extension that contain the word encrypt.

5. In the Destination folder/file(s) field, specify the location where to save the encrypted folders and
files.
This field supports wildcard characters in the file name and extension. Use an asterisk (*) to substitute
for one or more unknown alphanumeric characters or symbols.

6. Enter a value to append to the extension of the destination file.
7. Select the Overwrite Files check box to replace files with the same name.
8. Select the Compression type.

Scegli tra:
• Nessuno
• zip
• bzip2
• zlib

9. Select the Armor data (text output) check box to enable ASCII Armor output.
10. Fai clic su Salva.

Play Sound package
The Play Sound package contains actions that enable you to play a beep sound and media file before or
after an action is executed in a bot.
The Play Sound package includes the following actions:
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Action Descrizione

Riproduci segnale
acustico

Consulta Play beep action alla pagina 1743.

Riproduci file
multimediale

Consulta Play media file action alla pagina 1743.

Play beep action
The Play beep action enables you to play a beep sound before or after an action is executed.

Play media file action
The Play media file action enables you to play an audio file before or after an action is executed.

Impostazioni

From the Select a file to play field, select one of the following tabs to specify the location of the media
file:
• File Control Room: Use a file that is available on the Control Room.
• File desktop: Use a file that is available on a device.
• Variabile: Use a variable to specify the file location.

Nota:  Only .wav and .mp3 files are supported and do not require any media player installed on the
device.

Printer package
Use the actions in the Printer package to automate retrieving and setting the default printer and removing
a printer from the list of available printers.

Actions nel package Printer

Il package Printer include le seguenti actions:

Action Descrizione

Get Default Consulta Get default action alla pagina 1743.

Rimuovi Consulta Remove action alla pagina 1744.

Set Default Consulta Set default action alla pagina 1744.

Get default action
The Get default action enables you to retrieve the default printer and assign a value to a string variable.

Impostazioni

• Click the Select the destination string variableChoose a variable drop-down menu to select a
variable.
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• (Optional) Click Create variable icon if you do not have an existing variable.

Remove action
The Remove action enables you to delete or remove a printer.

Impostazioni

• Click the Enter the printer name drop-down menu to view a list of available printers, and select a
printer that you want to remove.

• (Optional) If the available printers are not listed, click the Refresh options icon.

Set default action
The Set default action enables you to set a default printer.

Impostazioni

• Click the Enter the printer name drop-down menu to view a list of available printers, and select a
printer that you want to set as the default one.

• (Optional) If the available printers are not listed, click the Refresh options icon.

Process package
The Process package contains a request action that enables the Control Room user to use this action and
configure their bots.

Prima di iniziare

Nota:  The Process package is now renamed to the AARI on the web package in Enterprise A2019.18
with the Create a Request action and additional new actions. Consulta AARI Web package alla pagina
1369.

Ensure you have met one of the following conditions in order to run this package:

Condizione 1 • Accesso a un processo in un team assegnato.
• Access to AARI User license.
• Ruolo Utente AAE_Robotic_Interface creato

dal sistema per l'utente AARI.

Condizione 2 • Accesso a una licenza Bot Runner (con o senza
operatore) o una licenza Bot Creator.

• Ruolo creato dall'utente con le autorizzazioni
Visualizza i miei bot ed Esegui i miei bot.
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Actions in the Process package

The Process package includes the following action:

Action Descrizione

Crea una richiesta Consente di creare una richiesta.
• In the Select Process field, select or upload your process.
• Specify your variable in the Dictionary or Variable field.

• Dizionario: Input your variable information in the Type, Key, and
Value fields.
In the Type field, you can choose between Any, String, Number,
Datetime, or Boolean.

• Facoltativo: Nel campo Aggiungi, aggiungi altre variabili
dizionario.

• Variabile: Inserisci la variabile personalizzata.

• Facoltativo: Nel campo Assegna l'ID della richiesta a, assegna
una variabile da memorizzare come output.
The output is stored as an ID value.

Prompt package
Use the Prompt package to accept an input value, a yes/no response, or to open a file or folder.

Actions nel package Prompt

Il package Prompt include le seguenti actions:

Action Descrizione

Per file Consulta For file action in Prompt alla pagina 1745.

Per cartella Consulta For folder action in Prompt alla pagina 1746.

Per valore Consulta For value action in Prompt alla pagina 1746.

Per sì/no Consulta For yes/no action in Prompt alla pagina 1746.

Riferimenti correlati
Message box package alla pagina 1690
Use the Message box action from the Message box package to insert a message box that shows a
message when the task runs. For example, you can insert a Message Box action to follow a web form so
that the action displays the message: Web Form Filled and Complete.

For file action in Prompt
The For file action in the Prompt package prompts you to select a single or multiple files on bot
execution.
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Impostazioni

• In the Prompt window caption field, enter a window caption.
• In the Prompt message field, enter a message.
• In the Assign the value to a variable field, specify a list variable.

For folder action in Prompt
The For folder action in the Prompt package prompts you to choose a folder.

Impostazioni

• In the Prompt window caption field, enter a window caption.
• In the Prompt message field, enter a message.
• In the Assign the value to a variable field, specify a variable.

For value action in Prompt
The For value action in the Prompt package prompts you to enter a value.

Impostazioni

• In the Prompt window caption field, enter a window caption.
• In the Prompt message field, enter a message.
• In the Assign the value to a variable field, specify a variable.

For yes/no action in Prompt
The For yes/no action in the Prompt package prompts you to choose a Yes/No response.

Impostazioni

• In the Prompt window caption field, enter a window caption.
• In the Prompt message field, enter a message.
• In the Assign the value to a variable field, specify a variable.

Python Script package
Il package Python Script contiene actions che abilitano le funzioni Python Script in un'attività.

Prima di iniziare

Assicurati che i seguenti requisiti siano soddisfatti prima di utilizzare il package Python Script:
• The appropriate version of Python is installed on the device on which you want to execute the script.

Nota:  Python versions 2.x and 3.x are supported.

• The "PATH" environment variable is updated to the path of the Python folder.
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Per verificare se la variabile ambiente Python è impostata correttamente, immetti Python nel prompt
dei comandi. If it returns the Python version that is installed, the path environment is set up correctly.

Esegui le seguenti actions contenute nel package Python Script come parte integrante dell'utilizzo del set di
actions disponibili:
1. Apri un file Python Script o inserisci manualmente lo script che desideri eseguire utilizzando l'action

Apri. You must associate the details of the file or script you want to run with a session name.
2. Esegui lo script utilizzando l'action Esegui funzione o Esegui script. You must use the same Python

Script session name established in the Open action.
3. Close the Python Script session after running the script.

Nota:  When you run a bot that contains Python Script actions, the script runs in the background.
To review the bot launcher logs, navigate to C:\ProgramData\AutomationAnywhere\BotRunner
\Logs\<current month>\Bot_Launcher-<today's date>.log.zip. Each zipped folder contains
a file with data on the code execution, which is useful for debugging.

Actions nel package Python Script

Il package Python Script include le seguenti actions:

Nota:  L'action Apri deve essere la prima action a utilizzare Python Script in un'attività. These actions can
run a Python Script on Windows, Linux, and UNIX-based devices.

Action Descrizione

Chiudi Consulta Close action alla pagina 1748.

Esegui funzione Consulta Execute function action alla pagina 1748.
For an example, see Example of using Python script to join a list alla pagina
2060.

Esegui script Consulta Execute script action alla pagina 1748.
For an example, see Create a PDF using Python script alla pagina 1749.

Apri Consulta Open action alla pagina 1748.

More resources

• bots gratuiti che utilizzano Python da Bot Store
• Python Excel demo
• Speech to text using Python
• Run Python script

• Developer content on automating with Python: Automate with Python integration
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Close action
The Close action in the Python Script package closes the session.

Impostazioni

Specifica lo stesso nome di sessione dell'action Apri.

Importante:  It is mandatory to close the session after the script is executed.

Execute function action
The Execute function action in the Python Script package enables you to execute a function within the
Python Script package.

Impostazioni

• Nel campo Python sessione, specifica un nome sessione. Utilizza lo stesso nome di sessione
dell'action Apri.

• Facoltativo: Specifica il nome della funzione da eseguire e gli argomenti da passare alla funzione.
Questo campo supporta variabili booleane, dizionario, elenco, numero e stringa.

Nota:  The interface allows you to select only one argument. Use a list variable to concatenate multiple
arguments into one variable.

• Facoltativo: Nel campo Assegna l'output alla variabile, specifica la variabile stringa.

Execute script action
The Execute script action in the Python Script package enables you to execute a script within the Python
Script package.

Impostazioni

• Nel campo Python sessione, specifica un nome sessione. Utilizza lo stesso nome di sessione
dell'action Apri.

• Facoltativo: Nel campo Assegna l'output alla variabile, specifica la variabile stringa.
If the bot executes the script successfully, this action returns the string True. Altrimenti appare un
messaggio di errore.

Open action
The Open action in the Python Script package opens the session.

Impostazioni

• Nel campo Python sessione, specifica un nome sessione. Utilizza questo stesso nome di sessione per
altre actions Python Script.

• Nel campo Python, scegli una delle seguenti opzioni:
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• Nell'opzione Importa file esistente, seleziona un file Python Script esistente.

Nota:  If you are uploading a script from a file on your desktop, the file and any dependencies must
be in a standalone folder. When you select a file for upload, all files and folders at the same folder
level are uploaded.

• Nell'opzione Input manuale, immetti Python Script.

• Nel campo Versione runtime di Python, seleziona 2 o 3 per specificare la versione runtime.

Nota:  Select the runtime version based on the version of Python installed on the device.

Create a PDF using Python script
Build a bot that runs Python script from a file and generates a PDF.
• To run Python script from Automation 360, you must already have the latest version of Python 3.x

installed on your device.
• This example uses the FPDF library to generate the PDF. Therefore, install it before you start building

this bot by copying and pasting the following line in the Windows command prompt:

pip install fpdf

Consulta FPDF project page.

1. Create a file in a standalone folder to hold the following Python script:
Insert your device username in the angle brackets.

from fpdf import FPDF
pdf = FPDF()
pdf.add_page()
pdf.set_font("Arial", size=12)
pdf.cell(200, 10, txt="Go Be Great!", ln=1, align="C")
pdf.output("C:/Users/<yourusername>/Desktop/sample_demo.pdf")

Nota:  If you are uploading a script from a file on your desktop, the file and any dependencies must
be in a standalone folder. When you select a file for upload, all files and folders at the same folder
level are uploaded.

2. Create a new bot:
a) Nel pannello di sinistra, fai clic su Automazione.
b) Fai clic su Crea nuovo > Bot.
c) In the Create Task Bot window, enter the bot name.
d) Accept the default folder location: \Bots\

To change the default bot storage location, click Choose and follow the prompts.
e) Fai clic su Crea e modifica.

3. Provide the script with a Python Script > Open action:
a) Double-click or drag the Python Script > Open.
b) Select the Import existing file option.
c) Click Browse to select the .py file you created in Step 1.
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4. Use a Python Script > Execute script action to tell the bot to run the script:
a) Double-click or drag Python Script > Execute script.

5. Close the script execution session with a Python Script > Close action:
a) Double-click or drag Python Script > Close.
b) Fai clic su Salva.

6. Click the Run icon.
The bot creates a PDF on the desktop with the text Go Be Great!.
To review the bot launcher logs, navigate to C:\ProgramData\AutomationAnywhere
\BotRunner\Logs\<current month>\Bot_Launcher-<today's date>.log.zip. Each
zipped folder contains a file with data on the code execution, which is useful for debugging.
If the bot does not create a file, change the last line in the Python script:

pdf.output(r"C:/Users/<yourusername>/Desktop/sample_demo.pdf")

Record package
The Record package contains actions that enable you to perform various operations on record-type
variables.

Action in the Record package

The Record package includes the following action:

Assegna Consulta Assign action in Record alla pagina 1750.

Assign action in Record
The Assign action in the Record package enables you to assign the value of the source record variable to
the destination record variable.

Impostazioni

• In the Select the source record variable field, select the source record variable from the drop-down
list or create a new record variable.

• In the Select the destination record variable field, select a destination record variable or create
one to hold the output.
• Record: Use this option to store the output in a record-type variable.
• Variabili multiple: Use this option to store the output in multiple variables by providing the key

and the variable to which the key is mapped. This variable can be of any type, such as String,
Number, Datetime, Boolean and so on. For example, if your source record variable contains two
entries; name and contact number, you can store the output as given below:

Chiave Mappa a variabile

Nome StrName
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Chiave Mappa a variabile

Contact number MobileNo

The variables StrName and MobileNo are String and Number type variables respectively.

Pacchetto Recorder
Il package Registratore acquisisce una serie di compiti in un processo e poi li automatizza. Puoi
automatizzare le applicazioni aziendali (per esempio, applicazioni desktop, web, SAP e Java) usando
Recorder per acquisire le actions eseguite su oggetti dell'applicazione come una casella di testo, un
pulsante, una tabella, un pulsante di opzione, una casella combinata e una vista elenco.

Automation 360 extension setting

If the bot execution takes longer when you use the Recorder to automate a static page running on the
Google Chrome or Microsoft Edge browser, then follow these steps to enable the setting in the Automation
360 extension:
• Click the extensions icon at the top right corner of the browser window.
• Click the vertical ellipses next to the Automation 360 plugin and select Manage extension.
• Enable the Allow access to file URLs option.
• Restart the browser and run the bot.

Benefits of using Recorder package instead of SAP package

We recommend that you use the Recorder to automate SAP applications. When you use the Recorder to
automate SAP applications, you have the following benefits:
• You can automate objects without creating a session. When you use the SAP package you must create

a session.
• You can automate the object directly without generating the field paths or having any prior knowledge

of the field paths. When you use the SAP package, the package will execute actions directly on control
field paths when properties in the search criteria match the object that the bot searches during
execution.

• If the Recorder runtime window overlaps the object that you want to automate, then the Recorder
hides the runtime window before you automate the object.

• Recorder supports actions in the If, Loop, and Wait packages that enables you to check if an object
exists in the specific browser or window.

Nota:  When compared to the Recorder package, the SAP package enables you to automate an application
without activating the application window.

action Acquisisci

Usa l'action Acquisisci per acquisire un'interazione con un oggetto dell'interfaccia utente (UI). Questa
action permette di aggiungere una singola interazione quando si costruisce un bot.

Nota:
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• L'action Acquisisci sostituisce il comando Object Cloning dalla Version 11.3.
• If you open a window in any of the supported browsers with a user account that is different from

the one used to log in to the computer, the Recorder might not capture and play the control actions
accurately.

Utilizzo dell'action Acquisisci alla pagina 1763
Puoi acquisire e automatizzare gli oggetti all'interno di un IFrame interdominio che ha più IFrame con
la stessa origine del frame e IFrame caricati dinamicamente in fase di esecuzione nei browser Google
Chrome e Microsoft Edge Chromium. Dopo aver acquisito un oggetto all'interno di un IFrame interdominio,
il percorso del frame è memorizzato, per impostazione predefinita, nella proprietà FrameDOMXPath.
You can automate the following applications running on Microsoft Edge Chromium with IE mode:
• Java web applications
• Applications that are accessed through the Citrix Workspace app.
• Citrix Virtual Apps

La nuova proprietà FrameDOMXPath identifica il frame in cui si trova l'oggetto. Devi selezionare questa
proprietà per eseguire il bot correttamente per acquisire oggetti su un IFrame interdominio.

Nota:  Se cancelli la proprietà FrameDOMPath dai criteri di ricerca, il comando Recorder non riesce a
identificare il frame.

Important:  Nel browser Google Chrome puoi acquisire e automatizzare gli oggetti all'interno di un
interdominio e utilizzare più frame con la stessa origine del frame.

Durante l'automatizzazione di una pagina web su un browser Google Chrome, Microsoft Edge Chromium,
or Mozilla Firefox, puoi acquisire finestre pop-up, finestre di dialogo di avviso, finestre di dialogo di
conferma e finestre di dialogo di richiesta.

Recommendations:
• Quando desideri automatizzare una finestra di dialogo di avviso su una pagina web, consigliamo di

aggiungere un ritardo prima di Registratore > Acquisisci action perché a volte la finestra di dialogo
di avviso appare dopo un ritardo sulla finestra dell'applicazione.

• Per acquisire o automatizzare con precisione gli oggetti delle applicazioni SAP, si consiglia di attivare lo
scripting. Se lo scripting non è abilitato, sotto la finestra di runtime bot viene visualizzato il seguente
messaggio di richiesta:
Scripting SAP disabilitato: Abilita lo scripting per acquisizioni più
affidabili

Se non abiliti lo scripting, invece di utilizzare la tecnologia SAP, Recorder utilizza la tecnologia MSAA per
l'acquisizione degli oggetti.

Automate applications running as an admin user

You can capture objects on applications that are running as an administrator by selecting the Capture
and run with admin privileges option from the Bot editor.

Before you automate applications running as an admin user, ensure the following:
• Bot Agent is installed in system profile.
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• Bot Creators and Bot Runners have admin rights on the device to automate the applications.

When you select the Start recording option in the Bot editor to record multiple applications, and switch
applications running in elevated and non-elevated mode, the bot might not be able to identify the change
between modes. In such cases, for all captures on applications in elevated mode, select the Capture and
run with admin privileges option and then re-capture the object.

Nota:  Elevated mode gives you permission to run applications as an administrator.

Importante:  When you try to automate any Java or SAP application that is non-elevated by using the
Recorder in elevated mode, the bot encounters an error.
To avoid this error, de-select the Capture and run with admin privileges option from the Bot editor
and run the Recorder in non-elevated mode to capture Java or SAP applications.

Proprietà oggetto

Quando selezioni un oggetto da acquisire, Universal Recorder raccoglie i dati sulle proprietà dell'oggetto
per identificare l'oggetto durante il runtime. Puoi eseguire le seguenti operazioni con le proprietà
dell'oggetto:
• verificare che le proprietà dell'oggetto acquisito corrispondano all'oggetto desiderato.

Ad esempio, quando acquisisci una tabella da un sito Web, assicurati che i valori Tipo di controllo e
Tag HTML siano TABELLA.

• Recuperare un valore di proprietà. Usa la proprietà Ottieni proprietàaction e inserisci il nome
della proprietà nel campo Nome proprietà o seleziona una proprietà dell'oggetto dall'elenco delle
proprietà disponibili. The list includes suggested property values from the search criteria in the Object
Properties table. To select an object property from the list of properties, move the mouse pointer to
the right of the Property name field and click the arrow.
Per esempio, per recuperare il testo di un collegamento, usa la proprietà Ottieni proprietàaction e
inserisci Testo interno HTML nel campo Nome proprietà o seleziona Testo interno HTML
dall'elenco delle proprietà.

• Puoi selezionare una combinazione di proprietà per il bot per cercare l'oggetto nella finestra
dell'applicazione aziendale in modo univoco.

L'algoritmo di ricerca del package Recorder assicura che quando si esegue un bot, un oggetto venga
acquisito solo se le sue proprietà corrispondono esattamente al criterio di ricerca selezionato nella tabella
Proprietà oggetto. Se le proprietà dell'oggetto non corrispondono esattamente al criterio di ricerca,
allora il bot ha esito negativo e viene visualizzato un messaggio di errore. Tuttavia, se il criterio di ricerca
include un carattere jolly, allora il bot acquisisce il primo oggetto che corrisponde al criterio.
Per esempio, per acquisire una casella di testo da un'applicazione che ha tre caselle di testo denominate
nome1, nome2 e nome3, se si seleziona Nome HTML come criterio di ricerca, inserire il valore nome
nel campo nome HTML ed eseguire il bot, in questo caso il bot avrà un esito negativo visualizzando un
messaggio di errore poiché la casella di testo con nome HTML nome non esiste. Tuttavia, nel campo
Nome HTML, se si inserisce nome* e si esegue il bot, allora il bot acquisirà la prima casella di testo
corrispondente al criterio.

Nota:  Questa funzionalità è disponibile per i bot creati utilizzando la versione 2.4.0-20211016-070100 del
package Recorder a partire da Automation 360 v.23. Se hai creato bots usando una versione precedente
del package Recorder è necessario acquisire nuovamente gli oggetti per utilizzare questa funzionalità.
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Azioni eseguite sugli oggetti acquisiti

Dopo aver acquisito l'oggetto, specifica l'azione che il bot deve eseguire sull'oggetto durante il runtime.
Ad esempio, quando acquisisci un collegamento ipertestuale, puoi scegliere se fare clic sul collegamento
o recuperarne il testo. Per visualizzare la tabella di tutti gli oggetti e le possibili azioni, consulta Actions
performed on objects captured with Universal Recorder alla pagina 1755.

Nota:  Se riscontri un errore durante l'esecuzione di un bot che acquisisce un oggetto da Internet Explorer
e il messaggio di errore riguarda Google Chrome, consulta Your Chrome Plug-in is either not installed or
disabled (A-People login required.

Elaborazione in background

L'elaborazione in background permette di eseguire in background un'automazione che comporta
l'interazione con un'applicazione in primo piano (come i clic del mouse). Si consiglia di utilizzare l'opzione
per l'esecuzione in background per aumentare la visibilità dell'oggetto di destinazione e migliorare la
precisione del bot. The following actions support background processing:
• Fai clic
• Imposta testo
• Ottieni testo

Registrazione sicura

Quando la modalità di registrazione sicura è abilitata, i bots non visualizzano le immagini dell'oggetto di
destinazione dopo l'acquisizione. Questo assicura che i dati sensibili non vengano mostrati.

Nota:  Anche se i bots non visualizzino le immagini di destinazione dopo l'acquisizione, le immagini sono
ancora memorizzate nella Control Room perché sono necessarie per eseguire i bots.

Quando registri un'attività in modalità di registrazione sicura, la finestra Anteprima mostra
temporaneamente un'immagine dell'area acquisita. Questa immagine è nascosta quando ti allontani dalla
finestra Bot editor o la aggiorni.
Questa impostazione deve essere abilitata da un utente con privilegi di amministratore. Consulta
Impostazioni alla pagina 2721.

Supporto proxy

Se il dispositivo è configurato con un proxy, tutte le richieste in uscita da questo package vengono
instradate tramite il server proxy. Consulta Connettere Bot Agent a un dispositivo con un proxy alla pagina
1046.

Casi d'uso su come usare il registratore

Usa queste attività di esempio per familiarizzare con l'uso del registratore nella costruzione di bots.
• Example of entering data into a web form from a worksheet alla pagina 2054
• Example of extracting data from a web table alla pagina 2053
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Riferimenti correlati
Universal Recorder for object-based automation alla pagina 1949
Utilizza il Universal Recorder per registrare le interazioni, ad esempio fare clic, leggere (estrazione dati) e
scrivere (immissione dati) con oggetti interfaccia utente (UI) sul desktop, nella barra delle applicazioni o in
un'applicazione o in una finestra del browser.
AISense per la registrazione di attività da applicazioni remote alla pagina 1965
AISense è la funzionalità basata sull'intelligenza artificiale (IA) di Automation 360 che consente di
identificare oggetti da un'immagine o da un'applicazione con un'interfaccia utente (UI) complessa e rende
l'automazione in tutti gli ambienti più veloce e precisa.

Actions performed on objects captured with Universal Recorder
After capturing the object, specify the action for the bot to do to the object at runtime. Ad esempio,
se acquisisci un collegamento ipertestuale, puoi selezionare un'azione per fare clic sul collegamento o
recuperarne il testo. Refer to the table below for the objects and their possible actions.

Nota:
• After you have captured an object and open the Action drop-down list, the list might offer actions for

an object that are not supported. Only use the actions for an object that are listed in the table below.
• You can capture any control type which is not yet supported by Microsoft UI Automation (COM)

technology as Client control. You can perform all actions that are available in Client control type
but only those actions that are supported for that specific control. For example, if you are capturing a
slider control which is not yet supported by Microsoft UI Automation (COM) technology, it is captured
as a Client control. You can perform only those actions that are supported by the slider control. For
example, you can perform the Click, Left click, Right click, and Double click actions but you
cannot perform the Set text action.

Oggetto Azioni

Pulsante • Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Click
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Casella di controllo • Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get status: retrieves whether the check box is selected. Returns
checked or unchecked.

• Check
• Uncheck
• Set focus
• Toggle: switches the check box to the opposite status. For example, if

the check box is checked, use the Toggle action to clear it.
• Left click: use this action if the Toggle action does not work during

Runtime.
• Right click
• Double click
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Oggetto Azioni

Client • Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get all children names: retrieves the names of all the child elements
of the captured control.
The child elements are the elements or controls that are available
under the parent control and are only visible when you use spy tools
like AccChecker.

• Get all children values: retrieves the values of all the child elements
of the captured control.

• Set text: enters text into the UI object. It supports credentials.
Credentials and credential variables in the Bot editor alla pagina 2039

• Click
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click
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Oggetto Azioni

ComboBox (appears as
a drop-down list)

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get total items: retrieves the number of items in the box.
• Get selected index: retrieves the item's position in the menu.

Nota:  Item index counts start at 1.

• Get selected item key: retrieves the key of the selected item.

Nota:  The Microsoft UI Automation (COM) technology does not
support this .

• Get selected text: retrieves the data from the selected item.
• Select item by index: selects the item that is located at the specified

index.

Nota:  Item index counts start at 1.

• Select item by text selects the item that matches the specified text.

Nota:  Il campo Assegna valore è sensibile alla distinzione tra
maiuscole/minuscole.

• Set focus

Nota:  The Microsoft UI Automation (COM) technology does not
support this .

• Expand

Nota:  The Microsoft UI Automation (COM) technology does not
support this .

• Click

Nota:  The Microsoft UI Automation (COM) technology does not
support this .

• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click
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Oggetto Azioni

GridView (SAP only) • Click on cell by index

Nota:  Index count starts at 1.

• Double click current cell
• Get total rows: retrieves the number of rows that contain values.
• Get total columns: retrieves the number of columns that contain

values.
• Get cell text by index: retrieves the data in the specified cell located

at the row and column index.

Nota:  Row and column index counts start at 1. Ad esempio, per
recuperare i dati nella cella A2, immetti 1 nel campo Riga e 2 nel
campo Colonna.

• Get cell index by text: retrieves the index of the cell containing the
specified text.

Nota:  The Cell Text field is case-sensitive.

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get table: retrieves the table data and saves it to a Table variable. Per
ulteriori informazioni, vedi Example of extracting data from a web table alla
pagina 2053

• Select all
• Set cell by index: enters text into the cell located at the row and

column index.

Nota:  Row and column index counts start at 1. Ad esempio, per
immettere il testo nella cella A2, immetti 1 nel campo Riga e 2 nel
campo Colonna.

• Set cell by text: enters text into the cell containing the specified text.

Nota:  The Find Text field is case-sensitive.

• Set current cell
• Set current row
• Set focus
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Etichetta • Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Set focus
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click
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Oggetto Azioni

Link

Nota:  The Microsoft
UI Automation (COM)
technology does not
support this control.

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Click
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

ListView • Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get total items: retrieves the number of items in the list.
• Get selected index: retrieves the item's position in the menu.

Nota:  Item index counts start at 1.

• Get selected text: retrieves the data from the selected item.
• Select item by index: selects the item that is located at the specified

index.

Nota:  Item index counts start at 1.

• Select item by text selects the item that matches the specified text.

Nota:  Il campo Assegna valore è sensibile alla distinzione tra
maiuscole/minuscole.

• Click
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Main window

Nota:  The Microsoft
UI Automation (COM)
technology does not
support this control.

• Get focus control id: retrieves the ID of the control that is in focus.
• Get property: retrieves the value of the specified object property

(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Set focus
• Send key
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click
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Oggetto Azioni

Menu

Nota:  The Microsoft
UI Automation (COM)
technology does not
support this control.

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get total items: retrieves the number of items in the menu.
• Get selected index: retrieves the item's position in the menu.

Nota:  Item index counts start at 1.

• Get selected text: retrieves the data from the selected item.
• Select item by index: selects the item that is located at the specified

index.

Nota:  Item index counts start at 1.

• Select item by text selects the item that matches the specified text.

Nota:  Il campo Assegna valore è sensibile alla distinzione tra
maiuscole/minuscole.

• Set focus
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Scheda pagina • Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get total items: retrieves the number of items in the tab.
• Get selected index: retrieves the item's position in the menu.

Nota:  Item index counts start at 1.

• Get selected text: retrieves the data from the selected item.
• Select item by index: selects the item that is located at the specified

index.

Nota:  Item index counts start at 1.

• Select item by text selects the item that matches the specified text.

Nota:  Il campo Assegna valore è sensibile alla distinzione tra
maiuscole/minuscole.

• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Nota:  When you capture a Page Tab control using Microsoft UI
Automation (COM) technology and perform Left click, Right click, or
Double click actions on the control, the actions will click on the point of
capture.
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Oggetto Azioni

Password text • Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Set text: enters text into the UI object. It supports credentials.
Credentials and credential variables in the Bot editor alla pagina 2039

• Click
• Left click: use this action if the Click action does not work during

Runtime.
• Right click
• Double click

RadioButton • Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get status: retrieves whether the radio button is selected. Returns
selected or deselected.

• Select
• Set focus
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Shell

Nota:  The Microsoft
UI Automation (COM)
technology does not
support this control.

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Slider

Nota:  The Microsoft
UI Automation (COM)
technology does not
support this control.

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Set position
• Right click
• Double click

Tab

Nota:  The Microsoft
UI Automation (COM)
technology does not
support this control.

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Scroll left
• Select
• Set focus
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click
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Oggetto Azioni

Tabella • Deselect all
• Get property: retrieves the value of the specified object property

(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get cell text by index: retrieves the data in the specified cell located
at the row and column index.

Nota:  Row and column index counts start at 1. Ad esempio, per
recuperare i dati nella cella A2, immetti 1 nel campo Riga e 2 nel
campo Colonna.

Nota:  For the Microsoft UI automation (COM) technology, the row and
column index counts start at 1, which includes the header row and the
leftmost column.

• Get cell index by text: retrieves the index of the cell containing the
specified text.

Nota:  The Cell Text field is case-sensitive.

• Get table: retrieves the table data and saves it to a Table variable. Per
ulteriori informazioni, consulta Example of extracting data from a web table
alla pagina 2053.
• When you use the Microsoft UI Automation (COM) technology to

capture the control, the Get table action also extracts the leftmost
column and header rows in the table.

• Get total rows: retrieves the number of rows that contain values.

Nota:  When you use the Microsoft UI Automation (COM) technology
to capture the control, the Get total rows action extracts a greater
number of rows (including the header in the rows) when compared to
the older technologies .

• Get total columns: retrieves the number of columns that contain
values.

Nota:  When you use the Microsoft UI Automation (COM) technology
to capture the control, the Get total columns action extracts a
greater number of columns (including the leftmost column) when
compared to the older technologies .

• Select row
• Select all
• Set cell by index: enters text into the cell located at the row and

column index.

Nota:  Row and column index counts start at 1. Ad esempio, per
immettere il testo nella cella A2, immetti 1 nel campo Riga e 2 nel
campo Colonna.

Nota:  For the Microsoft UI Automation (COM) technology, the row
and column index counts start at 1, which includes the header row and
the leftmost column.

• Set cell by text: enters text into the cell containing the specified text.

Nota:  The Find Text field is case-sensitive.

• Set focus
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Nota:  When you capture the table, the properties of item element are
also captured. You cannot use these captured properties as a selection
criterion because during bot runtime, the property value of item cannot be
searched.
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Oggetto Azioni

TextBox • Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Set focus
• Set text: enters text into the UI object. It supports credentials.

Credentials and credential variables in the Bot editor alla pagina 2039
• Append text: adds text to the end of existing text in the field, instead

of overwriting it.
• Click
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Toolbar

Nota:  The Microsoft
UI Automation (COM)
technology does not
support this control.

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Tree (Control is
displayed as a ListView)

Nota:  The Microsoft
UI Automation (COM)
technology does not
support this control.

• Expand node: expands the current node to down to the next level of
nodes.

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get total items: retrieves the number of items in the tree.
• Get selected index: retrieves the item's position in the menu.

Nota:  Item index counts start at 1.

• Get selected text: retrieves the data from the selected item.
• Select item by index: selects the item that is located at the specified

index.

Nota:  Item index counts start at 1.

• Select item by text selects the item that matches the specified text.

Nota:  Il campo Assegna valore è sensibile alla distinzione tra
maiuscole/minuscole.

• Set focus
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Utilizzo dell'action Acquisisci
Utilizza l'action Acquisisci per acquisire una singola interazione (clic, sequenza di tasti o movimento del
mouse) con un controllo dell'oggetto che include una casella di testo, un pulsante, una tabella, un menu,
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un pulsante di opzione, una casella combinata, una casella di controllo, una visualizzazione elenco, un
collegamento, un albero o una scheda pagina.
• To use the Recorder, you must already have done the following:

• Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039
• Set user device credentials alla pagina 1052

• Configure device display and font scale to 100%.
Se utilizzi la versione 2.0.6-20200626-193519 o successiva del package Recorder, puoi registrare le
attività nelle applicazioni di automazione Google Chrome, Internet Explorer, Java, Microsoft Active
Accessibility e Microsoft UI su un computer con scala di visualizzazione configurata al 100%, 125% o
150%.

• If you are automating a task using a browser, configure the zoom level to 100%.
If you are using Recorder package version 2.0.6-20200626-193519 or later, you can record tasks in a
Google Chrome browser that does not have a zoom level setting of 100%.

• If you are automating a task using a Google Chrome browser, ensure that the Automation Anywhere
plug-in that corresponds with the Automation 360 build version is enabled.
Requisiti del browser per RPA Workspace alla pagina 866

• To automate web applications running on Microsoft Edge Chromium browser in Internet Explorer mode
using the Universal Recorder, ensure that the Internet Explorer compatibility mode is enabled. The
objects on the web applications are captured using HTML technology. To enable this mode, perform the
following steps:
1. On the Microsoft Edge Chromium browser page, click Settings.
2. On the left panel, click Default browser.
3. Navigate to the Allow sites to be reloaded in Internet Explorer mode option and select

Allow.
4. Click Add to add the URL of the page that you want to load in Internet Explorer mode.

Nota:  The pages that you add open in Internet Explorer mode for 30 days from the date when
you add the page.

Considerations when recording a task:
• Use clicks when possible rather than shortcut keys.

Quando fai clic su un oggetto utilizzando Recorder, questo recupera le proprietà dell'oggetto che
consentono al bot di identificare l'oggetto in fase di runtime. Le scorciatoie da tastiera sono meno
affidabili, quindi usale quando non è possibile automatizzare l'attività con un clic su un oggetto.

• If you are automating a task using a browser, do not use autofill to enter values into fields.
• Record the task at low speed.
• Avoid dragging windows during the recording process.
• Avoid clicking on applications that are not part of the process you are recording and automating.
• When Internet Explorer is used, the action waits until the browser is completely rendered and is in a

ready state before executing the action.

To record a single interaction with an object control, follow these steps:
1. Fai doppio clic o trascina Registratore > Acquisisci.
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2. Specify the window in which to capture an object.
Choose from the Application, Browser, or Variable tab.
Opzione Descrizione

Applicazione Select from a list of currently active windows.
This option shows a list of all the application
and browser windows that are open on the Bot
Creator device.

Browser Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based
, and  browsers. For all other browsers, use the
Application option.

Variabile seleziona una variabile finestra esistente per
specificare il titolo del titolo della finestra
dell'applicazione.

3. Opzionale: Inserisci un carattere jolly (*) nel campo Titolo della finestra per cercare i titoli delle
finestre che possono cambiare. You can specify one or more wildcards (*) at the start, middle, or end
of the value.
For example, to perform an operation on any window that has Microsoft in the title, use a wildcard
to indicate any string by adding it before or after the value: *Microsoft*. The  first searches for
the exact window title (Microsoft), and if it does not find a match, it searches for windows with the
term Microsoft anywhere in the title.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
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you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

Nota:  During runtime, verify that the TaskBot identifies the correct window. If it does not, do the
following:
a. Open the application or browser window.
b. Trascina l'action Finestra > Ottieni titolo della finestra attiva sull'action Registratore >

Acquisisci.
c. Inserisci una variabile stringa nel campo Assegna il titolo della finestra a una variabile.
d. Trascina l'action Finestra > Imposta titolo sotto l'action Finestra > Ottieni titolo della

finestra attiva.
e. Nel campo Finestra, inserisci la variabile della finestra generata dall'action Registratore >

Acquisisci.
f. Nel campo Nuovo titolo della finestra, inserisci la variabile stringa dall'action Ottieni titolo

della finestra attiva.
g. Fai clic su Salva.

4. Opzionale: Seleziona l'opzione Ridimensiona finestra per specificare le dimensioni della finestra.
This option delivers a more reliable bot. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the botto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Nota:  This option is available only for windows that can be resized. Non è disponibile per le opzioni
Desktop o Barra dei comandi.

5. Fai clic su Acquisisci oggetto.
The selected window appears.

6. Move the mouse over the object you want to automate, for example, a button, form field, or a table.
A red rectangular box appears around the object.

Nota:  If the box does not appear and you are capturing in either the Google Chrome, Microsoft Edge,
or Mozilla Firefox browsers, verify that you have enabled the Automation Anywhere extensions for
these browsers. See Google Chrome browser extension requirements alla pagina 1959 for Google Chrome
browser.

7. Click the object.
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8. Esamina la tabella Proprietà oggetto.
Following are the list of object properties that are selected by default based on the technology type:

Important:  The following list does not include all the properties and is restricted to the most
commonly used and important properties based on the technology type

Technology type Proprietà oggetto Descrizione

Tipo di controllo This is a read-only property that shows the type
of object captured, for example, text box or
button.

DOMXPath È il percorso che viene utilizzato per localizzare
il controllo o l'oggetto acquisito. DOMXPath
può essere di due tipi: XPath relativo e XPath
assoluto.
• Xpath assoluto: Contiene il percorso

completo dall'elemento radice all'elemento
desiderato. For example, an absolute Xpath
for this topic would be /html/body/div/
div[1]/main/div[2]/div/div/div[2]/
div/div/div[1]/div/article/main/
article/div/p[1]

• Xpath relativo: Questo è un percorso più
breve che si riferisce a un elemento che si
vuole identificare. A relative path starts with
a // symbol. For example, the relative XPath
for this topic would be //*[@id="cloud-
using-recorder-action"]/div/p[1]

Ad esempio, se vuoi trovare il DOMXPath di un
particolare elemento sul browser Google Chrome,
esegui questi passaggi:
a. Seleziona l'elemento per il quale vuoi estrarre

l'XPath.
b. Fai clic con il tasto destro del mouse

sull'elemento e seleziona Ispeziona.
c. Right-click the highlighted element in the

Element tab.
d. Go to Copy > Copy Xpath to copy the

relative path and select Copy > Copy full
Xpath to copy the absolute path.

Percorso It is a numeric representation of the position
of a particular control in an application. For
web applications, the best practise is to use
DOMXPath from the search criteria when
comapred to Path.

Tecnologia HTML

Nome e ID HTML These properties are used to identify an HTML
object
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Technology type Proprietà oggetto Descrizione

Testo interno
HTML

La proprietà DOM innerText è utilizzata per
impostare o restituire il contenuto testuale di un
nodo specificato e dei suoi discendenti

Tag HTML I tag HTML sono come parole chiave che
definiscono il modo in cui il browser web
formatta e visualizza il contenuto. Ad esempio,
se il testo catturato ha un codice HTML: <h3
 class="search_results-title">Search
 results for ״string package״</h3>,
then enter h3 in the HTML tag field.

Tipo di controllo Questa proprietà è utilizzata solo come
riferimento per assicurare che l'oggetto corretto
sia acquisito

Percorso È una rappresentazione numerica della posizione
di un particolare controllo in un'applicazione

Nome Specifica il nome di un elemento e funziona come
un identificatore

Microsoft Active
Accessibility

ID Specifica l'ID di un elemento e funziona come un
identificatore

Tipo di controllo Questa proprietà è utilizzata solo come
riferimento per assicurare che l'oggetto corretto
sia acquisito

Java Technology

Percorso È una rappresentazione numerica della posizione
di un particolare controllo in un'applicazione

Tipo di controllo Questa proprietà è utilizzata solo come
riferimento per assicurare che l'oggetto corretto
sia acquisito

Percorso È una rappresentazione numerica della posizione
di un particolare controllo in un'applicazione

Nome Specifica il nome di un elemento e funziona come
un identificatore

Microsoft UI
Automation

ID Specifica l'ID di un elemento e funziona come un
identificatore

Tipo di controllo This property is used only as a reference to
ensure that the correct object is captured.

Percorso It is a numeric representation of the position of a
particular control in an application.

Microsoft UI
Automation (COM)

Nome This specifies a name of an element and works as
an identifier.
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Technology type Proprietà oggetto Descrizione

ID This specifies the ID of an element and works as
an identifier.

The bot uses the selected properties to identify the object control at runtime.
a) Verifica che il Tipo di controllo corrisponda all'oggetto desiderato.

For example, when capturing a table from a website, ensure the Control Type and HTML Tag
values are Table.
Se il Tipo di controllo non corrisponde all'oggetto desiderato, riacquisisci il controllo dell'oggetto.

b) Select and assign values to the object properties that you want to include in the object search.
Per un bot più affidabile, si consiglia di selezionare solo le proprietà che hanno valori statici (come
Name, Classe, Tipo, ID HTML e DOMXPATH) e deselezionare le proprietà che hanno valori
dinamici (come HTML Href, Percorso o Valore), che sono soggetti a cambiamenti e causano
errori nei bot.
It is a best practice to use the wildcard character (*) or variable in object property values to
search for objects whose properties are dynamic and changes frequently.

9. Seleziona Azione dall'elenco a discesa.
For a full list of possible actions by object, see Actions performed on objects captured with Universal
Recorder alla pagina 1755.
• If you record a click and keystrokes in a text box with a Control Type of Password text, the

Recorder does not capture the keystrokes entered into the field. Instead, the action selects the
Set text option and offers options to securely input the password. We recommend that you store
the password in the Credential Vault and insert it into the action as a credential.
See Credentials and credential variables in the Bot editor alla pagina 2039.
If you navigate to the text box using the TAB keystroke instead of a click in an MSAA or SAP
application, the Recorder is able to identify fields with a Control Type of Password text.

• If the selected Action supports background processing, a Run in the background option
appears.
Consulta Elaborazione in background alla pagina 1950.

10. Opzionale: Enter a value in the Keep trying for (seconds) field to specify the number of seconds
the bot must wait for the object control to appear on the application window.
We recommend setting a delay time when using the Set text action to enter keystrokes into a text
field.

Nota:  The timeout specified for the bot to wait for the control to appear on the application window
applies only if the window in which the control is present exists. The Recorder first looks for the
application window and only then searches for the object inside that window. The default time to
search for the window is 30 seconds. Hence, even if you specify the wait time as 5 seconds, it still
waits for 30 seconds by default if the window does not exist.

Nota:  We recommend that you first use a wait time of 0 second and ensure that the application
window exists and then specify a wait time of 5 seconds and run the bot to detect the object.

11. Opzionale: Assign the output to a variable.
La Control Room suggerisce un nome di variabile predefinito descrittivo basato sull'azione selezionata
al passaggio 8. For example, if you selected Get property, the suggested output variable is
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PropertyValue. If you create several output variables, subsequent variable names are appended
with a -1 to avoid duplication.

12. Fai clic su Salva.
The captured images are not added as dependencies and will not be displayed in the dependencies list
when you check in your bot.

Link an object to a supporting anchor

Nota:  You can use object anchoring in Microsoft Active Accessibility, Microsoft UI Automation, or Java
applications.

At runtime, if the bot cannot reliably identify an object, link it to a nearby object (such as a link or button)
that is easier for the bot to find:
1. Open the Capture action.
2. Click the Anchor tab.
3. Click Capture anchor.

The browser or application window activates with the main object highlighted (the object that you
previously captured). A dialog box appears, verifying whether the action has correctly identified the
main object.

4. If the correct object is highlighted, click Yes, Select anchor.
Otherwise, click No, I need to correct it to select the correct object.

5. Select a nearby object to the target object that is easier for the bot to find.
The object is highlighted with an anchor icon on the right of the object.

6. Click Save.

Capture using specific technology
In some applications, the Capture action might not work accurately if the technology for capturing is
selected automatically. In such cases, based on the type of application that you want to automate, you can
select a specific technology and use the Capture action to capture using that technology.

Utilizzo dell'action Acquisisci

To select a specific technology, click the drop-down next to Capture object.
You can select a specific technology and automate the following applications:
• Automate web applications that have nested iFrames with the same frame source or different frame

sources.
• Capture and automate objects on applications where automatic selection of technology might not

capture accurately.

Nota:  When you capture using a specific technology, the type and the number of object properties
differ.

• Automate all objects and controls on the Google Chrome and Microsoft Edge browsers for local setting
pages.

Nota:  Questa funzionalità è supportata dai browser Google Chrome e Microsoft Edge.
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Technology types

Puoi acquisire oggetti con le seguenti tecnologie:
• Microsoft Active Accessibility (MSAA)
• Microsoft UI Automation
• Microsoft UI Automation (COM)

Microsoft Active Accessibility (MSAA)

Microsoft Active Accessibility is a legacy accessibility technology that was introduced as a platform add-
in for Windows 95. MSAA is designed to help Assistive Technology (AT) products interact with standard
and custom user interface elements of an application and also to access, identify, and manipulate an
application's UI elements. MSAA is based on the Component Object Model (COM), which defines a
mechanism for applications and operating systems to communicate. To know more about the most
commonly used properties in this technology, see Utilizzo dell'action Acquisisci alla pagina 1763.

Microsoft UI Automation

Microsoft UI Automation is an accessibility framework for Microsoft Windows, and it is available on
all operating systems that support Windows Presentation Foundation (WPF). UI Automation provides
programmatic access to most user interface elements on the desktop, enabling AT products such as screen
readers to provide information about the UI to end users and to manipulate the UI by means other than
standard input. To know more about the most commonly used properties in this technology, see Utilizzo
dell'action Acquisisci alla pagina 1763.

Microsoft UI Automation (COM)

Microsoft UI Automation (COM) runs on unmanaged code and delivers automation faster than UI
Automation. You can capture the following controls using the Microsoft UI Automation (COM) technology:
• Pulsante
• Casella di controllo
• Client
• Casella combinata
• Etichetta
• List view
• Scheda pagina
• Password text
• Pulsante di opzione
• Tabella
• Casella di testo

When you select this technology to capture an object on an application, if that object is not supported for
the technology, that is indicated by a gray highlight around the object.

Nota:  Microsoft UI Automation (COM) provides a search criterion (property) called Automation ID,
which is unique to this technology.
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Recorder actions supported in various SAP versions
Review the information about the various actions of the Recorder package that are supported with
Automation 360 and which SAP GUI versions support them.

Control
name

Automation
360
supported
action

SAP Logon
730 (Patch
15)

SAP Logon
740 (Patch
19)

SAP Logon
750 (Patch
10)

SAP Logon
760 (Patch
5)

SAP Logon
770 (Patch
6)

Imposta
testo

Sì Sì Sì Sì Sì

Aggiungi
testo

Sì Sì Sì Sì Sì

Ottieni
proprietà

Sì Sì Sì Sì Sì

Imposta
come attivo

Sì Sì Sì Sì Sì

Left-click Sì Sì Sì Sì Sì

Right-click Sì Sì Sì Sì Sì

Casella di
testo
(Include
comandi
quali:
GuiCTextField,
GuiTextField,
GuiOkCodeField,
GuiShell:TextEdit,
GuiTextEdit,
and
GuiPasswordField)

Double-click Sì Sì Sì Sì Sì

Seleziona
elemento
per indice

Sì Sì Sì Sì Sì

Seleziona
elemento
per testo

Sì Sì Sì Sì Sì

Seleziona
elemento
per chiave

Sì Sì Sì Sì Sì

Espandi Sì Sì Sì Sì Sì

Ottieni
elementi
totali

Sì Sì Sì Sì Sì

Ottieni testo
selezionato

Sì Sì Sì Sì Sì

Get selected
item key

Sì Sì Sì Sì Sì

Ottieni indice
selezionato

Sì Sì Sì Sì Sì

Ottieni
proprietà

Sì Sì Sì Sì Sì

Imposta
come attivo

Sì Sì Sì Sì Sì

Left-click Sì Sì Sì Sì Sì

Casella
combinata
It includes
the control:
GuiCombobox

Right-click Sì Sì Sì Sì Sì
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Control
name

Automation
360
supported
action

SAP Logon
730 (Patch
15)

SAP Logon
740 (Patch
19)

SAP Logon
750 (Patch
10)

SAP Logon
760 (Patch
5)

SAP Logon
770 (Patch
6)

Double-click Sì Sì Sì Sì Sì

Spunta Sì Sì Sì Sì Sì

Deseleziona Sì Sì Sì Sì Sì

Toggle Sì Sì Sì Sì Sì

Ottieni stato Sì Sì Sì Sì Sì

Ottieni
proprietà

Sì Sì Sì Sì Sì

Imposta
come attivo

Sì Sì Sì Sì Sì

Left-click Sì Sì Sì Sì Sì

Right-click Sì Sì Sì Sì Sì

Casella di
controllo
It includes
the control:
GuiCheckBox

Double-click Sì Sì Sì Sì Sì

Fai clic Sì Sì Sì Sì Sì

Ottieni
proprietà

Sì Sì Sì Sì Sì

Set Focus Yes Yes Yes Yes Sì

Left-click Sì Sì Sì Sì Sì

Right-click Sì Sì Sì Sì Sì

Pulsante
It includes
the control:
GuiButton

Double-click Sì Sì Sì Sì Sì

Seleziona Sì Sì Sì Sì Sì

Ottieni stato Sì Sì Sì Sì Sì

Ottieni
proprietà

Sì Sì Sì Sì Sì

Imposta
come attivo

Sì Sì Sì Sì Sì

Left-click Sì Sì Sì Sì Sì

Right-click Sì Sì Sì Sì Sì

Pulsante di
opzione
It includes
the control:
GuiRadioButton

Double-click Sì Sì Sì Sì Sì

Imposta
cella per
indice

Sì Sì Sì Sì Sì

Imposta
cella per
testo

Sì Sì Sì Sì Sì

Tabella
It includes
the control:
GuiTableControl

Get cell text
by index

Sì Sì Sì Sì Sì
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Control
name

Automation
360
supported
action

SAP Logon
730 (Patch
15)

SAP Logon
740 (Patch
19)

SAP Logon
750 (Patch
10)

SAP Logon
760 (Patch
5)

SAP Logon
770 (Patch
6)

Get cell
index by text

Sì Sì Sì Sì Sì

Ottieni righe
totali

Sì Sì Sì Sì Sì

Get total
columns

Sì Sì Sì Sì Sì

Seleziona
riga

Sì Sì Sì Sì Sì

Seleziona
tutto

Sì Sì Sì Sì Sì

Deseleziona
tutto

Sì Sì Sì Sì Sì

Ottieni
proprietà

Sì Sì Sì Sì Sì

Imposta
come attivo

Sì Sì Sì Sì Sì

Left-click Sì Sì Sì Sì Sì

Right-click Sì Sì Sì Sì Sì

Double-click Sì Sì Sì Sì Sì

Ottieni
tabella

Sì Sì Sì Sì Sì

Seleziona
elemento
per testo

Sì Sì Sì Sì Sì

Ottieni
proprietà

Sì Sì Sì Sì Sì

Imposta
come attivo

Sì Sì Sì Sì Sì

Left-click Sì Sì Sì Sì Sì

Right-click Sì Sì Sì Sì Sì

Double-click Sì Sì Sì Sì Sì

Ottieni
elementi
totali

Sì Sì Sì Sì Sì

Seleziona
elemento
per indice

Sì Sì Sì Sì Sì

Barra dei
menu
It includes
the
control:GuiMenubar

Seleziona
elemento
per testo

Sì Sì Sì Sì Sì
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Control
name

Automation
360
supported
action

SAP Logon
730 (Patch
15)

SAP Logon
740 (Patch
19)

SAP Logon
750 (Patch
10)

SAP Logon
760 (Patch
5)

SAP Logon
770 (Patch
6)

Expand node Sì Sì Sì Sì Sì

Ottieni
proprietà

Sì Sì Sì Sì Sì

Imposta
come attivo

Sì Sì Sì Sì Sì

Ottieni
elementi
totali

Sì Sì Sì Sì Sì

Ottieni indice
selezionato

Sì Sì Sì Sì Sì

Ottieni testo
selezionato

Sì Sì Sì Sì Sì

Seleziona
elemento
per indice

Sì Sì Sì Sì Sì

Seleziona
elemento
per testo

Sì Sì Sì Sì Sì

Left-click Sì Sì Sì Sì Sì

Right-click Sì Sì Sì Sì Sì

Struttura ad
albero
It includes
the control:
GuiShell::Tree

Double-click Sì Sì Sì Sì Sì

Seleziona Sì Sì Sì Sì Sì

Scorri a
sinistra

Sì Sì Sì Sì Sì

Ottieni
proprietà

Sì Sì Sì Sì Sì

Imposta
come attivo

Sì Sì Sì Sì Sì

Left-click Sì Sì Sì Sì Sì

Right-click Sì Sì Sì Sì Sì

Tabulazione
It includes
the control:
GuiTab

Double-click Sì Sì Sì Sì Sì

Seleziona
tutto

Sì Sì Sì Sì Sì

Select cell by
index

Sì Sì Sì Sì Sì

Select cell by
text

Sì Sì Sì Sì Sì

Grid view
It includes
the control:
GuiShell::GridView

Set current
cell row

Sì Sì Sì Sì Sì
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Control
name

Automation
360
supported
action

SAP Logon
730 (Patch
15)

SAP Logon
740 (Patch
19)

SAP Logon
750 (Patch
10)

SAP Logon
760 (Patch
5)

SAP Logon
770 (Patch
6)

Seleziona
riga

Sì Sì Sì Sì Sì

Fai clic su
una cella per
indice

Sì Sì Sì Sì Sì

Doube-click
current cell

Sì Sì Sì Sì Sì

Ottieni righe
totali

Sì Sì Sì Sì Sì

Get total
columns

Sì Sì Sì Sì Sì

Get cell by
index

Sì Sì Sì Sì Sì

Get cell
index by text

Sì Sì Sì Sì Sì

Ottieni
proprietà

Sì Sì Sì Sì Sì

Imposta
come attivo

Sì Sì Sì Sì Sì

Left-click Sì Sì Sì Sì Sì

Right-click Sì Sì Sì Sì Sì

Double-click Sì Sì Sì Sì Sì

Ottieni
tabella

Sì Sì Sì Sì Sì

Invia VKey Sì Sì Sì Sì Sì

Get focus
control ID

Sì Sì Sì Sì Sì

Ottieni
proprietà

Sì Sì Sì Sì Sì

Imposta
come attivo

Sì Sì Sì Sì Sì

Left-click Sì Sì Sì Sì Sì

Right-click Sì Sì Sì Sì Sì

Finestra
principale
It includes
the control:
GuiMainWindow

Double-click Sì Sì Sì Sì Sì
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Control
name

Automation
360
supported
action

SAP Logon
730 (Patch
15)

SAP Logon
740 (Patch
19)

SAP Logon
750 (Patch
10)

SAP Logon
760 (Patch
5)

SAP Logon
770 (Patch
6)

Fai clic sul
pulsante per
l’indice

Sì Sì Sì Sì Sì

Select
content
menu item
by text

Sì Sì Sì Sì Sì

Ottieni
proprietà

Sì Sì Sì Sì Sì

Left-click Sì Sì Sì Sì Sì

Right-click Sì Sì Sì Sì Sì

Barra degli
strumenti
It includes
the control:
Toolbar
 control

Double-click Sì Sì Sì Sì Sì

Ottieni
proprietà

Sì Sì Sì Sì Sì

Imposta
come attivo

Sì Sì Sì Sì Sì

Left-click Sì Sì Sì Sì Sì

Right-click Sì Sì Sì Sì Sì

Etichetta
It includes
the control:
GuiLabel

Double-click Sì Sì Sì Sì Sì

Ottieni
proprietà

Sì Sì Sì Sì Sì

Imposta
come attivo

Sì Sì Sì Sì Sì

Left-click Sì Sì Sì Sì Sì

Right-click Sì Sì Sì Sì Sì

Il resto del
controllo
(Include
comandi
quali:
GuiMainWindow,
GuiBox,
GuiUserArea,
GuiTitlebar
e
GuiStatusbar)

Double-click Sì Sì Sì Sì Sì

REST Web Service package
Utilizza actions in REST Web Service package come metodi (DELETE, GET, PATCH, POST o PUT) per inviare
richieste a e ricevere risposte da un'API.

Lavorare con REST Web Service actions

Fornisci le seguenti informazioni per inviare una richiesta REST e ricevere una risposta. Non tutti i
parametri sono richiesti per tutti i metodi.
• Enter the URI: un indirizzo univoco per una risorsa API.
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• Proxy configuration: To set the proxy, select the System or Custom tab from Proxy configuration.

Opzione Descrizione

Sistema System proxy is the proxy configured on the
bot runner machine where the bot is running.
If this option is selected, the Bot Agent uses
the system proxy.

Personalizzazione This option allows you to configure custom
proxy settings within the actions of REST
Web Service. For example, if a REST API is
required to be routed through a different
proxy other than the system proxy, you can
select the Custom option and provide proxy
details within the REST actions.
Fornisci i seguenti dettagli:
Fornisci i seguenti dettagli:
• Host: The host name or IP address of the

proxy
• Porta: The port number of the proxy
• Username (Optional): The username

used for the proxy authentication
• Password (Optional): The password

used for the proxy authentication

Nota:  If the proxy to be configured
is authenticated proxy, then you must
provide authentication credentials in the
Username and Password fields.

For Host, Port, Username, and Password
fields, choose from Credential, Variable, or
Insecure string tab :
• Credenziale: Use a value available in the

credential vault.
• Variabile: Use a variable that stores a

credential value in a user-defined variable.
• Insecure string: Manually specify the

value that you want to use.

• Modalità di autenticazione: sono disponibili tre modalità di autenticazione supportate:
• No Authentication: Use this option to access the endpoints that does not require authentication to

access their servers.
• Base: Basic is the simplest way to authenticate users. When you select this option, you will enter

the username and password. This technique uses a header called Authorization, with a base64
encoded representation of the username and password entered.

• Utente AD connesso: gli utenti di Active Directory (AD) autorizzati ad accedere all'API correlata
vengono autenticati tramite AD. Nella richiesta non sono richieste le credenziali.

• Autenticazione Windows NT LAN Manager (NTLM) (Utente AD): un metodo di
autenticazione di sfida/risposta che consente ai client di fornire il proprio nome utente e password
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come credenziali crittografate o testo normale. Ti consigliamo di utilizzare le credenziali archiviate in
Automation Anywhere Credential Vault.

• Intestazione: non tutti i metodi richiedono un'intestazione. Le intestazioni rappresentano i metadati
associati alla richiesta.

• Tipo di contenuto: quando un'intestazione contiene un tipo di contenuto, definisce la negoziazione
del contenuto tra il client e il server. actions REST Web Service supporta i seguenti tipi di contenuto:
• application/x-www-form-urlencoded: Encode the parameters in the URL.
• JSON (application/json): Enter a JSON request body.
• XML (application/xml): Enter an XML request body.
• Text (text/plain)
• XML (text/xml)
• HTML (text/html)
• multipart/form-data: Send binary data, in most cases for uploading files to the server.

• Add substitution: Allows you to enter variables in the REST request body. A variable is a symbolic
representation of data, and it enables you to access a value without having to enter it manually
wherever you need it. For example, consider the following REST body request:

{
   "name":"{{name}}",
   "email":"{{email}}",
   "status":"Active"
}

In the above request body, you can replace the variables enclosed within double braces by clicking Add
substitution and adding the required values.

• Advanced options:
• Risposta di errore di acquisizione: seleziona la casella di controllo per acquisire la risposta di

errore tranne che per la risposta Operazione riuscita/Ok. I dettagli della risposta di errore
vengono acquisiti nel corpo della risposta.

• Consenti connessione non sicura durante l'utilizzo di https: seleziona la casella di controllo
per consentire la connessione non sicura quando usi https.

• Attendi il completamento dell'azione: puoi impostare un valore di time-out quando invii una
richiesta REST e ricevi una risposta. Quando esegui actions come POST, PUT, DELETE, PATCH e GET,
nel campo Attendi il completamento dell'azione puoi specificare il tempo di attesa (in millisecondi).
Per impostazione predefinita, il tempo di attesa è di 60.000 millisecondi.
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• Variabili di output: l'output della risposta viene acquisito in una variabile dizionario. Una variabile
dizionario è una coppia chiave-valore. Utilizza il nome dell'intestazione della risposta come chiave per
restituire il valore dell'intestazione, o "Corpo" come chiave per restituire il corpo della risposta.

Nota:  La chiave di risposta con il relativo valore è disponibile nella variabile dizionario per visualizzare
lo stato di risposta dell'API REST.

Per ottenere un elenco dei nomi di intestazione per la risorsa API, esegui queste operazioni:
1. Inserisci una action Loop dopo action REST Web Service.
2. Seleziona l'iteratore Per ogni chiave del dizionario.
3. Nel campo Variabile Dizionario, seleziona la variabile che contiene l'output action REST Web

Service.
4. Assign the value of each key to $prompt-assignment$.
5. Inserisci un'action Log To File.
6. Indica il percorso del file a un file di testo per contenere l'elenco dei nomi di intestazione.
7. Insert $prompt-assignment$ in the Enter text to log field.
8. Seleziona l'opzione Sovrascrivi file esistente.
9. Fai clic su Salva.

Quando esegui bot, vengono stampati i nomi di intestazione dalla risorsa API al file selezionato.

Passaggio dei valori in modo sicuro

Puoi passare in modo sicuro i valori dal Credential Vault al servizio web specificando locker, le credenziali e
l'attributo nei seguenti campi action supportati:
• URI
• Intestazioni personalizzate
• Corpo: For the application/x-www-form-urlencoded content type, click Add parameter to

select the value from the Credential Vault.
Per tutti gli altri tipi di contenuto, seleziona l'opzione Seleziona credenziali come parametri e fai
clic su Seleziona.

Actions nel package REST Web Service

Action Descrizione

Elimina metodo Rimuove la risorsa identificata dall'URI.
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Action Descrizione

metodo Get Recupera le informazioni identificate dai parametri inclusi nell'URI.
Non esiste alcun Tipo di contenuto per il metodo GET, perché tutti i
parametri vengono passati come parte dell'URI.
I limiti e le caratteristiche del metodo GET includono quanto segue:
• la lunghezza dell'URI è limitata a 2048 caratteri.
• Tutti i parametri vengono passati nell'URI.
• Il metodo GET espone i dati presenti nell'URI, rendendolo meno sicuro

rispetto al metodo POST.
• Il metodo GET non modifica alcun dato, rendendolo sicuro per tutti gli

utenti indipendentemente dall'autorizzazione.

Consulta Using the Get method alla pagina 1781.

Metodo patch Modifica la risorsa identificata dall'URI.

metodo POST Crea una nuova risorsa nell'URI.
• I parametri vengono passati nel corpo della richiesta.
• Non esiste un limite di lunghezza per un corpo della richiesta.

Consulta Using the Post method alla pagina 1785.

metodo PUT Aggiorna o sostituisce una risorsa in base ai parametri passati nell'URI o
nel corpo. Consulta Using the Put method alla pagina 1787.

Supporto proxy

Se il dispositivo è configurato con un proxy, tutte le richieste in uscita da questo package vengono
instradate tramite il server proxy. Consulta Connettere Bot Agent a un dispositivo con un proxy alla pagina
1046.
Attività correlate
Example of building a bot that uses credential variables alla pagina 2042
Securely pass values to a bot using credential variables to automate the process of logging in to a bank
website.
Riferimenti correlati
Credentials and credential variables in the Bot editor alla pagina 2039
Use credentials when building bots to pass sensitive information such as passwords and account numbers.
Using credentials separates the sensitive information from the bots and Bot Runners, which reduces the
risk of data spillage or unauthorized user access.

Using the Get method
Use the Get method actions from the REST Web Service package to retrieve or get the information
identified by parameters included in the URI .
This example uses endpoints from the Swagger Petstore sample API (Petstore) to demonstrate using Get
method action to retrieve data from the Petstore database.

Nota:  GET method action does not take any request body.

1. Create a new .
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a) Accedi alla tua istanza di .
b) Nel pannello di sinistra, fai clic su Automazione.
c) Fai clic su Crea nuovo > Bot.
d) In the Create Task Bot window, enter the  name.
e) Accept the default folder location: \Bots\

To change the default  storage location, click Choose and follow the prompts.
f) Fai clic su Crea e modifica.
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2. Use the Get method action to retrieve a list of all the available pets.
a) Double-click or drag the REST Web Services > Get method action.
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b) Enter the following URI:

https://petstore.swagger.io/v2/pet/findByStatus?status=available

c) Under Authentication Mode drop-down, select No Authentication as this endpoint does not
require authentication.

Nota:  Typically endpoint requires authentication to ensure that only authorized applications are
able to access the data. Select an appropriate authentication mechanism to allow access to the
endpoint you want to access.

d) Create the variable Output in the Assign the output to a variable field. For more information
on creating a variable, see Create a variable alla pagina 2030.

3. Insert a Log to file action to see the response body.
a) Double-click or drag the Log to file action.
b) Provide the file path to a text file.
c) In the Enter text to log field, enter $Output{Body}$.

4. Click Save and then click Run.
The bot retrieves the response body and saves it to the text file.

Vedi anche
• REST Web Service package alla pagina 1777
• Using the Post method alla pagina 1785
• Using the Put method alla pagina 1787
• Upload file with Put method alla pagina 1788

Using the Post method
Use the Post method actions from the REST Web Service package to create new resources in the URI.
This example uses endpoints from the Swagger Petstore sample API (Petstore) to demonstrate using Post
method action to add data to the Petstore database.
1. Create a new .

a) Accedi alla tua istanza di .
b) Nel pannello di sinistra, fai clic su Automazione.
c) Fai clic su Crea nuovo > Bot.
d) In the Create Task Bot window, enter the  name.
e) Accept the default folder location: \Bots\

To change the default  storage location, click Choose and follow the prompts.
f) Fai clic su Crea e modifica.
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2. Use the Post method action to add a new pet to the store.
a) Double-click or drag the REST Web Services > Post method action.
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b) Enter the following URI:

https://petstore.swagger.io/v2/store/order

c) Under Authentication Mode drop-down, select No Authentication as this endpoint does not
require authentication.

Nota:  Typically endpoint requires authentication to ensure that only authorized applications are
able to access the data. Select an appropriate authentication mechanism to allow access to the
endpoint you want to access.

d) Copy and paste the following into the Custom parameters field, replacing the text in the angle
brackets with the value that you copied from the file:

{
  "id": 0,
  "petId": 0,
  "quantity": 0,
  "shipDate": "2022-04-20T22:08:11.977Z",
  "status": "placed",
  "complete": true
}

e) Create the variable Output in the Assign the output to a variable field. For more information
on creating a variable, see Create a variable alla pagina 2030.

3. Insert a Message box action to see the response body.
a) Double-click or drag the Log to file action.
b) In the Enter the message to display field, enter $Output{Body}$.

4. Click Save and then click Run.
The bot displays the response in the message box.

See also

• REST Web Service package alla pagina 1777
• Using the Get method alla pagina 1781
• Using the Put method alla pagina 1787
• Upload file with Put method alla pagina 1788

Using the Put method
Use the Put method actions from the REST Web Service package to update or replace existing resource.
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This example uses endpoints from the Swagger Petstore sample API (Petstore) to demonstrate using Put
method action to update data to the Petstore database.
1. Use the Put method action to update the pet name to "Pluto" and pet status to "sold".

a) Double-click or drag the REST Web Services > Put method action.
b) Enter the following URI:

https://petstore.swagger.io/v2/pet

c) Open the log file saved in Using the Get method alla pagina 1781 and copy the Pet ID of the first
entry.

d) Copy and paste the following into the Custom parameters field, replacing the text in the angle
brackets with the value that you copied from the file:

{
  "petId": 0,
   "name": "Pluto",
  "status": "sold"
}

e) Insert the variable Output in the Assign the output to a variable field.

2. Move the Message box action below the Put method action:
a) Fai doppio clic su o trascina l'action Finestra di messaggio.
b) In the Enter text to log field, enter $Output{Body}$.

3. Click Save and then click Run.
The bot retrieves the response body and prints it to the Message box. A successful response includes
"name":"Pluto","status":"sold".

See also

• REST Web Service package alla pagina 1777
• Using the Post method alla pagina 1785
• Using the Get method alla pagina 1781
• Upload file with Put method alla pagina 1788

Upload file with Put method
Use the Put method action in the REST Web Service package to upload a file or text.
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This example uses endpoints from the Petstore sample API (Petstore) to demonstrate uploading a new
file or text using a multipart/form-data.
1. Use the Put method action in conjunction with an API that allows uploading a file.

a) Double-click or drag the REST Web Services > Put method action.
b) Enter the following URI:

https://petstore.swagger.io/v2/pet/112/uploadImage

c) From the Content type drop-down, select multipart/form-data.

d) Add the file parameter and provide the path of the file to be uploaded.
e) Add any other required parameters. For instance, this API takes additonatalMetadata (for

example, "hello"), which is a text input parameter. The additional parameter will also be uploaded.
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2. Assign the output to a variable, for example, Test123.

3. Print the output in a message box.

See also

• REST Web Service package alla pagina 1777
• Using the Post method alla pagina 1785
• Using the Get method alla pagina 1781
• Using the Put method alla pagina 1787

Elimina metodo
Use the Delete method action in the REST Web Service package to remove a resource that is identified by
the URI.

Metodo patch
Use the Patch method action in the REST Web Service package to action modify the resource that is
identified by the URI.
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Salesforce package
Salesforce is a cloud-based platform that provides software and services to create relevant customer
experiences.
Salesforce is based on a multi-tenant architecture with benefits such as API integration, configuration,
scalability, free capacity, platform support, and more. The Salesforce package uses the Lightning
Platform APIs to integrate Automation 360 with Salesforce. RPA developers need to authenticate to build
automation processes in Salesforce. After authentication, with the Salesforce Connected App, you can
upload or download files, perform CRUD (Create/Insert, Read, Update/Upsert, Delete) operations on
Objects (Salesforce stores data as Objects), and query using SOQL.
The following video shows the initial authentication and command actions from Automation 360:
Two types of objects are available in Salesforce, Standard Objects and Custom Objects. Standard Objects
include the configuration and default data types. Custom Objects are the objects that are defined
according to business requirements. In this topic, sample CRUD operations will be based on the Case
Object, which is a Standard Object. A Case Object is typically used to gather customer data (queries,
feedback, or problems). All the samples are based on manipulating the fields of the Case Object. For more
information on the Case Object, see Salesforce Case object. All the CRUD operations are initiated from the
Automation 360 side and will update data on the Salesforce side.

Salesforce Authentication action
Salesforce Authentication is the first command action that you need to call to get authenticated with
the Salesforce.
Authenticate access to Salesforce by getting the authentication parameters from the Salesforce connected
app and using them in Automation 360.
1.

Log in to the Salesforce Enterprise Edition (Lightning Experience - Salesforce Login), click , and
select Setup on your connected app. For more information about creating a new connected app, see
Configure RPA Bots for Salesforce callback integration .
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2. In the Lightning Experience App Manager, click App Manager.

3. Click the down arrow next to app name and select View.
The Manage Connected Apps screen appears. For more information about managing connected
apps, see Salesforce Connected Apps.
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4. Click Manage Consumer Details.
a) Click Copy that corresponds to Consumer Key.
b) Click Copy that corresponds to Consumer

Secret.

5. Accedi a Control Room.
6. Create a new .

a) Accedi alla tua istanza di .
b) Nel pannello di sinistra, fai clic su Automazione.
c) Fai clic su Crea nuovo > Bot.
d) In the Create Task Bot window, enter the  name.
e) Accept the default folder location: \Bots\

To change the default  storage location, click Choose and follow the prompts.
f) Fai clic su Crea e modifica.

© 2023 Automation Anywhere. All rights reserved.     1793



    Automation Anywhere - Crea

7. From the Actions pane, select Salesforce > Authentication and place it under the Start of the bot
flow.
Opzione Fasi

Client ID/Client secret/ Salesforce
username/Salesforce password

Select one of the following options to specify
the Client ID/Client secret/ Salesforce
username/Salesforce password:
• Credenziale: Enables you to use a value

available in the Credential Vault that contains
information about the Client ID/Client secret/
Salesforce username/Salesforce password.

• Variabile: Enables you to use a credential
variable that contains information about the
Client ID/Client secret/ Salesforce username/
Salesforce password.

• Insecure string: Enables you to enter the
Client ID/Client secret/ Salesforce username/
Salesforce password for the Salesforce
Authentication.

a) In the Client ID field, paste the Consumer Key copied from the Salesforce Connected App. In
this illustration Insecure string is used, while you can use Credential or Variable options for
better security.
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b) In the Client Secret field, paste the Consumer Key copied from the Salesforce Connected App.

c) Enter the Salesforce username.
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d) Enter the Salesforce password.
e) Enter the API version. You can find the API version using the https://

MyDomainName.my.salesforce.com/services/data/" format="html"
 scope="external, replace MyDomainName with your Salesforce URL. For more information
on obtaining the Salesforce URL, see the below step.

f) Select Production to log into a live environment or Sandbox to log into a testing environment.
g) Enter Default as the Session name.

8. Create either a Multiple or Dictionary variable to store the response. You can do one of the
following:
• The authentication command returns a dictionary with 2 key-value pairs. Authorization

(credential type) and InstanceUrl (String type). The Authorization is hidden, but you will be
able to read the InstanceUrl. For example, you can use a message box to print of the value of ,
$str_Authresponse{InstanceUrl}$, this returns the Salesforce URL.

• You can select Multiple variable as shown below and map to a credential variable and a string
variable as keys.

Authorization returns a token, which is hidden as it is a credential type, this token can be passed
directly in the Rest Web Services command.

9. Click Run to save and run your bot. Once authenticated, you will be able to use the token to call other
Salesforce API services.

Salesforce Insert record action
Use the Salesforce Insert record action to insert a new record into a Salesforce object along with values
of the fields that should be mapped to the object's fields.

Nota:  Ensure that you are authenticated before calling any Salesforce action. For more information about
authentication, see Salesforce Authentication action alla pagina 1791.

In this tutorial, you will insert a few fields into a Salesforce object by using the Insert record action.
1. From the Actions pane, select Salesforce > Insert record and place it in the canvas.
2. Enter the following fields:

a) Enter the Object name, for example, Case.

Nota:  For Salesforce Custom objects, ensure that you provide the API name
instead of the Display name of the object. For example, provide API name:
AAIRPA__Salesforce_Connection__c and not the display name: Salesforce Connection"
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For more information on how to find the API name, see https://help.salesforce.com/s/articleView?
id=000327123&type=1.
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b) Enter the Fields and data that you want to insert. Choose either Dictionary or Entry list. In
this sample, Dictionary is selected and a few fields in Case object are modified. For example,
Status is set to New and Origin is set to Web.
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c) Enter Default as the session name.
d) Save the outcome to a variable. For example, the object ID is saved to Str_RecordID.
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3. Verify whether the value is inserted into Salesforce.
a) Find the value of the Str_RecordID variable in the Debug mode.

b) In Salesforce, go to the Case object with the record ID (for example, 5004W000026rD5tQAE) that
you received as the response.
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Verify whether the field's values match the input that you sent from Automation 360. For
example, in this case, the Status is New and Case Origin is Web.

Salesforce Get record action
The Salesforce Get record action is used to read the fields of a Salesforce object.

Nota:  Ensure that you are authenticated before calling any Salesforce action. For more information about
authentication, see Salesforce Authentication action alla pagina 1791.

To read the field of a Salesforce object by using the Get record action, perform the following steps:
1. From the Actions pane, select Salesforce > Get record and place it in the canvas.
2. Enter the following fields:

a) Enter the Object name, for example, Case.

Nota:  For Salesforce Custom objects, ensure that you provide the API name
instead of the Display name of the object. For example, provide API name:
AAIRPA__Salesforce_Connection__c and not the display name: Salesforce Connection"
For more information on how to find the API name, see https://help.salesforce.com/s/articleView?
id=000327123&type=1.
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b) Enter the Record ID that you want to read. You will also be able to read data using the
External ID. For more information on External ID, see Salesforce Upsert record action alla
pagina 1810.
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c) Select List for the Fields and data (Optional) field. Enter all the fields that you want to read.
In this sample, the field Status is read.
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d) Save the outcome to a variable. For example, the object ID is saved to SFDC_Res.

3. Click Run to start the bot. You will be able to read the value of the field by simply printing the value in
a Message box action. For example, in this sample, $SFDC_Res{Status}$ will print New

Salesforce Update record action
Update the fields of Salesforce Objects by using the Salesforce Update record action.

Nota:  Ensure that you are authenticated before calling any Salesforce action. For more information about
authentication, see Salesforce Authentication action alla pagina 1791.

To update a field in a Salesforce Object by using the Update record action, perform the following steps:
1. From the Actions pane, select Salesforce > Update record and place it in the canvas.
2. Enter the following fields:

a) Enter the Object name, for example, Case.

Nota:  For Salesforce Custom objects, ensure that you provide the API name
instead of the Display name of the object. For example, provide API name:
AAIRPA__Salesforce_Connection__c and not the display name: Salesforce Connection"
For more information on how to find the API name, see https://help.salesforce.com/s/articleView?
id=000327123&type=1.
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b) Enter the Record ID that you want to update.

© 2023 Automation Anywhere. All rights reserved.     1807



    Automation Anywhere - Crea

© 2023 Automation Anywhere. All rights reserved.     1808



    Automation Anywhere - Crea

c) In the Fields and data (Optional) field, select Entry List. Click Add new field/value pair to
update and enter the Field name that you want to update and the Field value (optional) that
you want the field to be updated with. For example, enter Status as Field name and In progress
as Field value (optional) in Fields and data. You can also choose Dictionary and enter the
values as a key/value pair.

d) Save the outcome to a variable. For example, the object ID is saved to SFDC_Res.
e) Enter the Record ID that you want to update.

3. To start the bot, click Run. You can verify the update by checking it in the Salesforce side. The
following video shows the process:

Salesforce Delete record action
Delete records from Salesforce by using the Salesforce Delete record action.

Nota:  Ensure that you are authenticated before calling any Salesforce action. For more information about
authentication, see Salesforce Authentication action alla pagina 1791.

To delete a field of a Salesforce object, use the Delete record action.
1. From the Actions pane, select Salesforce > Delete record and place it in the canvas.
2. Enter the following fields:

a) Enter the Object name, for example, Case.

Nota:  For Salesforce Custom objects, ensure that you provide the API name
instead of the Display name of the object. For example, provide API name:
AAIRPA__Salesforce_Connection__c and not the display name: Salesforce Connection"
For more information on how to find the API name, see https://help.salesforce.com/s/articleView?
id=000327123&type=1.
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b) Enter the Record ID that you want to delete.

3. Click Run to start the bot. You will be able to verify the deletion by checking it on the Salesforce side.
The following video shows the process:

Salesforce Upsert record action
Insert or update a record by using the Salesforce Upsert record action. The Upsert action uses a
custom external ID as the key to identify a record.
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Nota:  Ensure that you are authenticated before calling any Salesforce action. For more information about
authentication, see Salesforce Authentication action alla pagina 1791.

1. From the Actions pane, select Salesforce > Upsert record (using External ID) and place it in
the canvas.
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2. Enter the Object name, for example, Case.
3. Enter the field name that will store the ExternalID.

Nota:  In this sample, the ExternalID is generated by using the Generate random string action.

4. Enter the ExternalID generated.
5. Enter the fields that you want to update.
6. To verify, you can store the generated recordID in a variable. The following video demonstrates how to

inserting fields to a record created in Salesforce.

7. To update a field by using the Upsert record action, from the Actions pane, select Salesforce >
Upsert record (using External ID) and place it in the canvas.

8. Enter the Object name, for example, Case.

Nota:  For Salesforce Custom objects, ensure that you provide the API name
instead of the Display name of the object. For example, provide API name:
AAIRPA__Salesforce_Connection__c and not the display name: Salesforce Connection"
For more information on how to find the API name, see https://help.salesforce.com/s/articleView?
id=000327123&type=1.

9. Enter the same field name that will store the ExternalID.
10. Enter the same ExternalID to refer to the same record.
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11. Enter the Field Name and new Field Value to update in Fields and data. You can also choose
Dictionary and enter the values as a key/value pair.

12. To verify, you can store the outcome to a variable, for example, Dict_ExternalId-update.

Salesforce Execute SOQL action
To search your Salesforce data for specific information, run the Salesforce Object Query Language (SOQL)
command from Automation 360 by using the Salesforce Execute SOQL action.
SOQL is similar to Structured Query Language (SQL) but is tailored for Salesforce data. For more
information about SOQL, see Salesforce Execute SOQL.

© 2023 Automation Anywhere. All rights reserved.     1814

https://developer.salesforce.com/docs/atlas.en-us.228.0.soql_sosl.meta/soql_sosl/sforce_api_calls_soql.htm


    Automation Anywhere - Crea

To get specific information from Salesforce data, execute a query from Automation 360.
To send an SOQL query to Salesforce by using the Execute SOQL action, perform the following steps:

Nota:  Ensure that you are authenticated before calling any Salesforce action. For more information about
authentication, see Salesforce Authentication action alla pagina 1791.

1. From the Actions pane, select Salesforce > Execute SOQL and place it in the canvas.

2. Enter the following fields:
a) Enter the SOQL query to execute, for example, Select Status From Case Where Id =

'5004W000026rD4HQAU'.

Nota:  For Salesforce Custom objects, ensure that you provide the API name
instead of the Display name of the object. For example, provide API name:
AAIRPA__Salesforce_Connection__c and not the display name: Salesforce Connection"
For more information on how to find the API name, see https://help.salesforce.com/s/articleView?
id=000327123&type=1.

b) Select one of the following options:
• If you want to include the deleted records, select Yes.
• If you do not want to include the deleted records, select No.

c) Enter Default as the session name.
d) Save the outcome to a variable. For example, all the fields of the records can be stored in a list

(List_SOQL)
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3. Verify that you can run the bot in Debug mode with a breakpoint set to an action next to Execute
SOQL. For example, in the sample provided previously, there is a Message box action. Open the
List_SOQL variable to view the results.

Salesforce Upload file attachment action
You can upload a file to a record in Salesforce with the Salesforce Upload file attachment action.

Nota:  Ensure that you are authenticated before calling any Salesforce action. For more information about
authentication, see Salesforce Authentication action alla pagina 1791.

1. From the Actions pane, select Salesforce > Upload file attachment and place it in the canvas.
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2. Enter the following fields:
a) Enter the Object's record ID to which you want to upload the file. Ad esempio:

'5004W000026rD4HQAU'.
b) Enter a Content document record ID (optional).

It is necessary only when you want to upload a newer version of an existing file.
c) Select a location from where you want to upload the file. You will be able to select one of the

following:
Control Roomfile: When you select this option, you can select a file from your Control Room.
File desktop: When you select this option, you can select a file from your computer. In this
sample, a file is uploaded from a folder in the computer.
Variabile: When you select this option, you can select variable that points to a file.

Nota:  Make sure that the file path that you are referring to contains the file with the exact name
as entered in this field.

d) Enter the Display name (Optional) to save the uploaded file in this name.
e) Set the Visibility as required.
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• AllUsers: The file is available to all users who have permission to see the file.
• InternalUsers: The file is available only to internal users who have permission to see the file.
• SharedUsers: The file is available to all users who can see the feed to which the file is

posted. SharedUsers is used only for files shared with users and is available only when an
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org has private org-wide sharing on by default. The SharedUsers value is available in API
version 32.0 and later.

f) Enter Default as the session name.
g) Save the outcome to a variable. For example, the version of the saved document can be saved in

a variable, such as DocVersionID.

3. To verify, you can run the bot and see whether the file is uploaded to the record in the Salesforce. The
following video demonstrates uploading a file from a computer to Salesforce.

Salesforce Download file attachment action
You can download a file from a record in Salesforce by using the Salesforce Download file attachment
action.

Nota:  Ensure that you are authenticated before calling any Salesforce action. For more information about
authentication, see Salesforce Authentication action alla pagina 1791.

1. From the Actions pane, select Salesforce > Download file attachment and place it in the canvas.
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2. Enter the following fields:
a) Enter the Object's record ID from which you want to download the file. Ad esempio:

'5004W000026rD4HQAU'

b) Enter the Destination folder where you want to save the file.

c) Set Download all files/filter by to one of the following options:
All files: Download all the attached files from a record.
File name: Download a file by entering a file name.
File extension: Download all the files with the same extension that you enter.
Content document ID: Download a particular version of a file.

d) Enter Default as the session name.
e) Save the outcome to a variable. For example, the details of the downloaded files can be saved in

a variable, such as ListResponse
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3. To verify, you can run the bot and whether the file is downloaded to the specified location. The
following video demonstrates how to download a file from Salesforce to a location on a local system.

Nota:  The file is downloaded from the ContentDocument Object.

SAP package
Il package SAP contiene actions per l'automazione di attività e processi su un'applicazione SAP.
Il package SAP consente di eseguire le seguenti attività:
• Reduce the time required to combine data from disparate systems.
• Eliminate human error and increase efficiency.
• Increase the number of transactions processed.
• Deliver real-time information to various stakeholders.
• Enhance decision-making through comprehensive reports.

Nota:  Nell'azione SAP Connetti, il campo Nome sessione non può essere condiviso con TaskBots o
altri bots.

Prerequisiti

• Log in to the SAP GUI before capturing objects because the SAP Logon screen is not supported for
object capture.

• Enable GUI scripting and accessibility.
Vedi Abilitazione dello scripting sul lato client, Abilitazione dello scripting sul lato server e Abilitazione delle
impostazioni di accessibilità.

• Ensure that one of the following SAP GUI for Windows is installed on the devices that you use to
automate SAP-related tasks and to run these tasks:
• SAP GUI 750 with patch 9
• SAP GUI 760 with patch 0
• SAP GUI 760 with patch 1
• SAP GUI 760 with patch 5
• SAP GUI 770 with patch 6

Nota:  Se SAP GUI 760 con patch 0 è installato sul tuo dispositivo, non puoi usare le actions del
controllo SAP Vista griglia Imposta testo cella tabella e Ottieni testo cella tabella a causa di un
problema con SAP GUI 760 con patch 0.

• Install a Scripting Tracker or a similar tool to retrieve the field path of the SAP object.

Prima di iniziare
Esegui le seguenti actions contenute nel package SAP come parte integrante dell'utilizzo del set di actions
disponibili:
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1. Stabilisci una connessione con l'applicazione SAP utilizzando l'action Connetti.
Log in to the SAP application using the SAP GUI application. Utilizza quindi l'action Connetti dal
package SAP per utilizzare questa connessione e assegnare un nome sessione. Utilizza questo stesso
nome di sessione per le altre actions.

2. Utilizza le actions per automatizzare un'attività.
3. Dopo aver automatizzato tutte le attività correlate a SAP, termina la connessione all'applicazione SAP

utilizzando l'action Disconnetti.

Actions nel package SAP

Il package SAP include le seguenti actions:

Nota:  The SAP and the Recorder package can detect SAP elements in the application. However, from a
usability standpoint, the Recorder package is preferred over the SAP package as it is more intuitive when
compared to the SAP package, such as detecting SAP Object paths automatically. Vedi Benefits of using
Recorder package instead of SAP package alla pagina 1751

Action Descrizione

Seleziona/deseleziona
casella di controllo

Check/uncheck check box action alla pagina 1823

Fai clic Click action alla pagina 1823

Fai clic sul menu Click menu action alla pagina 1824

Connetti Using Connect action for SAP alla pagina 1824.

Disconnetti action Disconnetti alla pagina 1824

Fai doppio clic Double click action alla pagina 1825

Espandi Expand action alla pagina 1825

Esporta tabella Using Export table action alla pagina 1825.

Ottieni conteggio
cellule

Get cell count action alla pagina 1826

Get children name Get children names action alla pagina 1826

Ottieni testo figli Get children text action alla pagina 1826

Ottieni conteggio
colonna

Get column count action alla pagina 1827

Ottieni conteggio riga Get row count action alla pagina 1827

Ottieni, per l’elemento
selezionato,

Get selected item action alla pagina 1827

Ottieni stato Get status action alla pagina 1827

© 2023 Automation Anywhere. All rights reserved.     1822



    Automation Anywhere - Crea

Action Descrizione

Ottieni l’indice di una
cella di tabella

Get table cell index action alla pagina 1828

Ottieni il testo di una
cella di tabella

Get table cell text action alla pagina 1828

Ottieni testo Get text action alla pagina 1828

Ottieni conteggio
elementi

Get item count action alla pagina 1829

Fai clic con il tasto
sinistro

Left click action alla pagina 1829

Fai clic con il tasto
destro

Right click action alla pagina 1829

Seleziona elemento Select item action alla pagina 1829

Seleziona opzione
radio

Select radio option action alla pagina 1829

Send virtual key Virtual keys in SAP GUI

Send virtual key action alla pagina 1830

Set table cell text Set table cell text.

Imposta testo Set text action alla pagina 1830

Check/uncheck check box action
The Check/uncheck check box action in the SAP package enables you to select or clear a check box in a
SAP window.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione SAP
nell'action Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

• Nell'opzione Azione, seleziona Seleziona, Deseleziona o Toggle.

Click action
The Click action in the SAP package enables you to perform a click operation.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.
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Click menu action
The Click menu action in the SAP package enables you to click a menu item by text or index in a SAP
window.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

• Nell'opzione Seleziona, seleziona Nome o Indice per specificare il nome o l'indice della voce di menu.

Using Connect action for SAP
Use the Connect action to establish a connection with a SAP system that you want to use to automate
SAP-related tasks. This must be the first action you use to automate an SAP-related task.
1. Nella tavolozza Actions, fai doppio clic o trascina l'action Connetti dal package SAP.
2. Specify a name for the session in the Session name field.
3. Select an option to specify the connection type:

a) If you have selected Automatic, no additional information is required to connect to the SAP
application.
You must be already logged on to SAP logon application as the system uses the available SAP
session to connect to a SAP system.

b) If you have selected SAP GUI, you must manually provide the following details:
• Name: Specify the value in the Name field. The value must be same as entered in the

Description field of the SAP logon system connection parameters.
• Client: Specify a value for the client identifier. You can enter a value of 0 through 999.
• User name: Click the Credential tab to select an entry from the Credential Vault. You can

also click the String tab to enter a value manually.
• Password: Click the Credential tab to select an entry from the Credential Vault. You can also

click the String tab to enter a value manually.
• Language: Specify the two-letter code for the language set on the SAP server.

4. Fai clic su Salva.

Attività correlate
Using Export table action alla pagina 1825
Use the Export table action to export a table to a datatable or CSV file.
Using Set table cell text action alla pagina 1830
Use the Set table cell text action to set the text in a specific cell of a table or a grid.
Riferimenti correlati
SAP package alla pagina 1821
Il package SAP contiene actions per l'automazione di attività e processi su un'applicazione SAP.

action Disconnetti
The Disconnect action in the SAP package enables you to terminate the connection to the SAP application.
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Impostazioni

Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione  nell'
Connetti.

Double click action
The Double click action in the SAP package enables you to perform a double-click operation on a SAP
window.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

Expand action
The Expand action in the SAP package enables you to expand the item by text or index on a SAP window.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

• Nell'opzione Seleziona, seleziona Testo o Indice per specificare il testo o l'indice dell'elemento.

Using Export table action
Use the Export table action to export a table to a datatable or CSV file.
To export a table, follow these steps:
1. In the Actions palette, double-click or drag the Export table action from the SAP package.
2. In the Session name field, enter the session name you used to connect to the SAP application in the

Connect action.
3. Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione

dell'oggetto.
You can use Recorder capture action to capture SAP controls and retrieve the field path or install a
Scripting Tracker or a similar tool to retrieve the field path of the SAP object.
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4. In the Export As option, select CSV or Datatable to specify the export option of the table cell:
Choice Fasi

CSV a. In the File Path field, specify the location or
file variable.

b. Facoltativo: In the Encoding field, specify
the value.

c. Select the Export data with header check
box to export with header.

d. In the When saving field, select Append
to existing log file or Overwrite existing
log file to append the log file or overwrite
the content within the log file.

Datatable In the Datatable field, specify the value.

5. Fai clic su Salva.

Get cell count action
The Get cell count action in the SAP package enables you to get number of cells in a table or grid.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

• Nel campo Assegna l'output a una variabile, specifica la variabile.

Get children names action
The Get children names action in the SAP package enables you to get children control names.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

• Nel campo Assegna l'output a una variabile elenco, specifica la variabile elenco.

Get children text action
The Get children text action in the SAP package enables you to get the text associated with children
control.
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Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

• Nel campo Assegna l'output a una variabile elenco, specifica la variabile elenco.

Get column count action
The Get column count action in the SAP package enables you to get number of columns in a table or grid.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

• Nel campo Assegna l'output a una variabile, specifica la variabile.

Get row count action
The Get row count action in the SAP package enables you to get number of rows in a table or grid.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

• Nel campo Assegna l'output a una variabile, specifica la variabile.

Get selected item action
The Get selected item action in the SAP package enables you to get selected item index from a combo box,
page tab, or a tree view control.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

• Nel campo Assegna l'output a una variabile, specifica la variabile.

Get status action
The Get status action in the SAP package enables you to get status of a radio button or check box.
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Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

• Nel campo Assegna l'output a una variabile, specifica la variabile.

Get table cell index action
The Get table cell index action in the SAP package enables you to get table cell index for text.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

• Nel campo Cerca testo, specifica il testo.
• Seleziona l'opzione Ricerca tenendo conto di maiuscolo e minuscolo per specificare una ricerca

con distinzione tra maiuscole e minuscole.
• Seleziona la casella di controllo Tutte le occorrenze.
• Nel campo Assegna l'output a una variabile, specifica la variabile.

Get table cell text action
The Get table cell text action in the SAP package enables you to get table cell text by index.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

• Nel campo Riga, specifica il numero della riga di cui desideri ottenere il testo.
• Nel campo Colonna, specifica il numero della colonna di cui desideri ottenere il testo.
• Nel campo Assegna l'output a una variabile, specifica la variabile.

Get text action
The Get text action in the SAP package enables you to get text from a text box, label, or status bar.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

• Nel campo Assegna l'output a una variabile, specifica la variabile.
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Get item count action
The Get item count action in the SAP package enables you to get the count of items in a combo box, page
tab, or tree view control.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

• Nel campo Assegna l'output a una variabile, specifica la variabile.

Left click action
The Left click action in the SAP package enables you to perform a left-click operation.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

Right click action
The Right click action in the SAP package enables you to perform a right-click operation.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

Select item action
The Select item action in the SAP package enables you to select an item by text or index.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

• Nell'opzione Seleziona, seleziona Testo o Indice per specificare il testo o l'indice dell'elemento.

Select radio option action
The Select radio option action in the SAP package enables you to select the radio button in a SAP window.
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Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

Send virtual key action
The Send virtual key action in the SAP package enables you to send a virtual key.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nell'elenco Seleziona, seleziona un tasto.
Consulta Tasti virtuali nella GUI di SAP.

Using Set table cell text action
Use the Set table cell text action to set the text in a specific cell of a table or a grid.
To set a value in a table cell, follow these steps:
1. In the Actions palette, double-click or drag the Set table cell text action from the SAP package.
2. In the Session name field, enter the session name you used to connect to the SAP application in the

Connect action.
3. Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione

dell'oggetto.
4. In the Select option, select Text or Index to specify the text or index of the table cell:

• Text: In the Find Text field, specify the value.
The system searches for the cell that contains the value.

• Index: In the Row and Column fields, specify the value.

5. In the Set Text field, enter the text to set the table cell.
6. Fai clic su Salva.

Set text action
The Set text action in the SAP package enables you to set the text in an editable field.

Impostazioni

• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione 
nell' Connetti.

• Nel campo Percorso campo, specifica la posizione o una variabile stringa contenente la posizione
dell'oggetto.

• Nel campo Valore campo, specifica il testo.

Nota:  You can set the fields to any value, including blank values, for example, text field or date field.
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• Seleziona la casella di controllo Aggiungi testo.

BAPI SAP package
Il package BAPI SAP contiene actions per automatizzare attività e processi tramite la BAPI (Business
Application Programming Interface) SAP. BAPI è un metodo standardizzato che consente a un'applicazione
di terze parti di interagire con un sistema SAP.

Overview of SAP BAPIs

Business Application Programming Interfaces (BAPIs) are APIs that enable external applications to access SAP
business objects.
Typically, a BAPI consists of the following parameters:
• Import parameters: Used to receive data from the calling applications.
• Export parameters: Used to return data to the calling application.
• Import/export table parameters: Tables used for both receiving data and returning data.

A parameter can be of the following type:
• Data element: Scalar data type
• Struttura: Typically contains multiple fields

If an import parameter is of the type structure, you can pass multiple values as key-value pairs.
• Tabella: A data structure that contains more than one row

For a BAPI method to work, the calling application can call the method in a BAPI using the following:
• Nome BAPI
• Import parameters (scalar, structure, table)
• Export parameters (scalar, structure, table)

Prima di iniziare
Esegui le seguenti actions nel BAPI SAP package come parte integrante dell'utilizzo del set di actions
disponibili:
1. Stabilisci una connessione con l'applicazione SAP utilizzando l'action Connetti.
2. Utilizza l'action Crea funzione per creare una funzione definita dall'utente per la funzione BAPI SAP

specificata.
Seleziona l'opzione Inizia sequenza per contrassegnare l'inizio di un processo seguito dalle actions
per automatizzare un'attività.

3. Utilizza l'action Esegui funzione per eseguire la funzione creata utilizzando l'azione Crea funzione.
Seleziona l'opzione Termina sequenza per contrassegnare la fine di un processo e l'opzione Esegui
commit transazione per confermare le modifiche.

Actions nel package BAPI SAP

Il package BAPI SAP include le actions seguenti:
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Action Descrizione

Connetti Using Connect action for SAP BAPI alla pagina 1832.

Crea funzione Create function action alla pagina 1834.

Ottieni valore campo Get field value action alla pagina 1834.

Ottieni struttura Get structure action alla pagina 1835.

Ottieni tabella Get table action alla pagina 1835.

Esegui funzione Run function action alla pagina 1836.

Imposta valore campo Set field value action alla pagina 1836.

Run standard workflow Run standard workflow action alla pagina 1836.

Esegui flusso di lavoro
personalizzato

Run custom workflow action alla pagina 1837.

Build sample bots using the SAP BAPI package

If you are getting started with the SAP BAPI package, a good place to start is to build some sample bots
with the help of the following tutorials. The tutorials are intended to train you on how to use various
actions from the SAP BAPI package to invoke SAP BAPIs, pass import parameters, and retrieve data from
export parameters.
• Example of using Get structure command from SAP BAPI package alla pagina 2079: In this tutorial, you

will build a  that invokes BAPI_FLIGHT_GETLIST from the SAP demo Flight Data application. When
executed, the  calls the BAPI function by inputting an airline ID and destination details, gets a list of
flights, and writes the response data to a CSV file.

• Example of writing data to SAP using SAP BAPI package alla pagina 2082: In this tutorial, you will build
a  that invokes BAPI_FLCUST_CREATEFROMDATA from the SAP demo Flight Data application. You will
use the CUSTOMER_DATA import parameter to pass the customer data to the BAPI. When executed,
the  creates a new customer record in SAP database and displays the customer number returned by the
BAPI.

• Example of using Run standard workflow from SAP BAPI package alla pagina 2084: In this tutorial, you
will build a bot that uses a single action to select a BAPI from a list of function modules, to set import
parameters, and to get the response data. When executed, the bot gets flight availability data based on
the input data, and writes it to a CSV file.

Using Connect action for SAP BAPI
Use the Connect action to establish a connection with a SAP system that you want to use to automate
SAP-related tasks using SAP Business Application Programming Interface (BAPI). This must be the first
action you use to automate an SAP-related task using SAP BAPI.
Download the SAP Java connector package and DLL from the SAP website.
1. Nella tavolozza Actions, fai doppio clic o trascina l'action Connetti dal package SAP.
2. Specify a name for the session in the SAP BAPI Session field.
3. Select one of the following options to specify the location of the SAP Java connector package:

• File Control Room: Enables you to select the SAP Java connector package that is available in a
folder in the Control Room.

• Desktop profile: Enables you to select the SAP Java connector package that is available on your
device.

© 2023 Automation Anywhere. All rights reserved.     1832



    Automation Anywhere - Crea

• Variabile: Enables you to specify the file variable that contains the location of the SAP Java
connector package.

4. Select one of the following options to specify the location of the SAP JCo DLL dependency:
• File Control Room: Enables you to select the SAP Java connector DLL that is available in a folder

in the Control Room.
• Desktop profile: Enables you to select the SAP Java connector DLL that is available on your

device.
• Variabile: Enables you to specify the file variable that contains the location of the SAP Java

connector DLL.

5. Select one of the following options to specify the connection type:
Opzione Fasi

Server applicazioni personalizzate Select one of the following options to specify the
SAP server hostname:
• Credenziale: Enables you to use a value

available in the Credential Vault that contains
information about the SAP server hostname.

• Variabile: Enables you to use a credential
variable that contains information about the
SAP server hostname.

• Insecure string: Enables you to enter the
hostname for the SAP server.

Gruppo/Server a. Select one of the following options to specify
the SAP message server hostname:
• Credenziale: Enables you to use a

value available in the Credential Vault
that contains information about the SAP
message server hostname.

• Variabile: Enables you to use a
credential variable that contains
information about the SAP message
server hostname.

• Insecure string: Enables you to specify
the hostname for the SAP message
server.

b. Facoltativo: Specify the gateway host you
want to use to connect to the server in the
Gateway host field.

c. Facoltativo: Specify the logon group you
want to use to connect to the server in the
Logon group field.
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6. Enter values for the following:
• Numero sistema
• Facoltativo: ID sistema istanza SAP
• Numero client
• Codice lingua di accesso
• Facoltativo: Stringa router
• Select one of the following options to specify the username you want to use to connect to the SAP

server:
• Credenziale: Enables you to use a value available in the Credential Vault that contains the

username.
• Variabile: Enables you to use a credential variable that contains the username.
• Insecure string: Enables you to enter the username.

• Select one of the following options to specify the password you want to use to connect to the SAP
server:
• Credenziale: Enables you to use a value available in the Credential Vault that contains the

password.
• Variabile: Enables you to use a credential variable that contains the password.
• Insecure string: Enables you to enter the password.

7. Fai clic su Salva.

Create function action
The Create function action in the SAP BAPI package enables you to create an alias for a SAP BAPI function
and saves it with an alias name.

Impostazioni

È possibile utilizzare il nome alias in altre actions per utilizzare la funzione BAPI in queste actions.
• Nel campo Nome sessione, immetti il nome della sezione utilizzata per connetterti all'applicazione SAP

nell'action Connetti.
• Nel campo Nome alias funzione, immetti l'alias che si desidera utilizzare per la funzione BAPI.
• Nel campo Nome BAPI, immetti il nome della funzione BAPI SAP per la quale si desidera creare l'alias.
• Seleziona l'opzione Inizia sequenza, se si desidera eseguire la BAPI in una sequenza particolare per

contrassegnare l'inizio di un processo.

Get field value action
The Get field value action in the SAP BAPI package enables you to obtain data of a specific field from a
function, table, or structure.

Impostazioni

• Nel campo Alias funzione BAPI, immetti l'alias fornito per la funzione BAPI SAB utilizzando l'action
Crea funzione.

• Seleziona una delle seguenti opzioni per specificare se si desidera ottenere dati da una funzione, tabella
o struttura:
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• Funzione: Consente di ottenere il valore di un campo da una funzione.
• Tabella: Consente di ottenere il valore di un campo da una tabella in una funzione BAPI SAP.

È necessario specificare l'Alias tabella dalla quale si desidera ottenere i dati.
È necessario utilizzare l'action Ottieni tabella prima di utilizzare l'action Ottieni campo per
ottenere il valore di un campo da una tabella in una funzione BAPI SAP. È inoltre necessario
specificare l'Alias tabella dalla quale si desidera ottenere i dati.

• Struttura: Consente di ottenere dati da una struttura in un'applicazione SAP.
È necessario utilizzare l'action Ottieni struttura prima di utilizzare l'action Ottieni campo per
ottenere il valore di un campo da una struttura nella funzione BAPI SAP. È inoltre necessario
specificare l'Alias tabella dalla quale si desidera ottenere i dati.

• Nel campo Nome campo, immetti il nome del campo dal quale si desidera ottenere i dati.
• In the SAP BAPI Session field, enter the session name you used to connect to the SAP application in

the Connect action.
• Nel campo Salva l'output in una variabile, specifica una variabile stringa.

Get structure action
The Get structure action in the SAP BAPI package enables you to obtain table data from a structure using
the function alias.

Impostazioni

• Nel campo Alias funzione BAPI, immetti l'alias fornito per la funzione BAPI SAB utilizzando l' Crea
funzione.

• Nel campo Nome struttura, immetti il nome della struttura dalla quale si desidera ottenere i dati.
• In the SAP BAPI Session field, enter the session name you used to connect to the  application in the

Connect .
• Seleziona una delle seguenti opzioni per specificare come salvare i dati recuperati dalla struttura:

• Alias: Consente di fornire un alias per la struttura e di utilizzare tale alias in altre actions.
• Variabile: Consente di memorizzare i dati recuperati dalla struttura in una variabile tabella.

Get table action
The Get table action in the SAP BAPI package enables you to get tabular data from a table using the
function alias.

Impostazioni

• Nel campo Alias funzione BAPI, immetti l'alias fornito per la funzione BAPI SAB utilizzando l' Crea
funzione.

• Nel campo Nome tabella, immetti il nome della tabella dalla quale si desidera ottenere i dati.
• In the SAP BAPI Session field, enter the session name you used to connect to the  application in the

Connect .
• Seleziona una delle seguenti opzioni per specificare come salvare i dati recuperati dalla tabella:

• Alias: Consente di fornire un alias per la tabella e di utilizzare tale alias in altre actions.
• Variabile: Consente di memorizzare i dati recuperati dalla tabella in una variabile tabella.
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Run function action
The Run function action in the SAP BAPI package enables you to run the SAP BAPI function.

Impostazioni

• Nel campo Alias funzione BAPI, immetti l'alias fornito per la funzione BAPI SAB utilizzando l' Crea
funzione.

• Seleziona l'opzione Termina sequenza per contrassegnare la fine di un processo e l'opzione Esegui
commit transazione per confermare le modifiche apportate durante il processo.
Per terminare una sequenza, è necessario selezionare l'opzione Inizia sequenza dall'azione Crea
funzione. Se è stata utilizzata la Chiamata di funzione remota in coda (qRFC), è necessario selezionare
l'opzione Esegui commit transazione per confermare le modifiche apportate.

• In the SAP BAPI Session field, enter the session name you used to connect to the  application in the
Connect .

Set field value action
The Set field value action in the SAP BAPI package enables you to set data into a function, table, or
structure using the function alias.

Impostazioni

• Nel campo Alias funzione BAPI, immetti l'alias fornito per la funzione BAPI SAB utilizzando l' Crea
funzione.

• Seleziona una delle seguenti opzioni per specificare se si desidera impostare i dati in una funzione,
tabella o struttura:
• Funzione: Consente di impostare i dati in una funzione.
• Tabella: Consente di impostare i dati in una tabella in un'applicazione SAP.

È necessario utilizzare l'action Ottieni tabella prima di utilizzare l'action Ottieni campo per
ottenere il valore di un campo da una tabella in una funzione BAPI SAP. È necessario specificare
l'Alias tabella in cui si desidera impostare i dati. È inoltre possibile selezionare l'opzione Crea
nuova riga se si desidera creare una nuova riga nella tabella e impostare il valore in quella riga.

• Struttura: Consente di impostare i dati in una struttura in un'applicazione SAP.
È necessario utilizzare l'action Ottieni struttura prima di utilizzare l'action Ottieni campo per
ottenere il valore di un campo da una struttura nella funzione BAPI SAP. È inoltre necessario
specificare l'Alias struttura da cui si desidera ottenere i dati.

• Nel campo Nome campo, immetti il nome del campo in cui si desidera impostare i dati.
• In the Field Value field, enter the value that you want to set.
• In the SAP BAPI Session field, enter the session name you used to connect to the  application in the

Connect .

Run standard workflow action
The Run standard workflow action in the SAP BAPI package enables you to run a standard workflow in SAP
BAPI.
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Impostazioni

• Utilizza l'opzione Seleziona flusso di lavoro per selezionare il flusso di lavoro dalla finestra di dialogo
Selettore BAPI standard.

• La sezione Importa in BAPI visualizza i parametri di importazione per il flusso di lavoro selezionato.
È possibile selezionare l'opzione Modifica dal menu azione (puntini di sospensione verticali) per
specificare un valore per i parametri.
• Seleziona l'opzione Includi se si desidera utilizzare quel parametro di importazione.
• Seleziona la scheda Tabella per selezionare una variabile tabella contenente i valori che si desidera

importare in BAPI. In alternativa, seleziona la scheda Stringhe per specificare manualmente il
valore.

• Nella sezione Esporta in BAPI vengono visualizzati i parametri di esportazione per il flusso di lavoro
selezionato. È possibile selezionare l'opzione Modifica dal menu azione (puntini di sospensione
verticali) per specificare un valore per i parametri.
• Seleziona l'opzione Includi se si desidera utilizzare quel parametro di esportazione.

• La sezione Tabelle visualizza le tabelle che è possibile utilizzare come parametri di esportazione o
importazione per il flusso di lavoro selezionato. È possibile selezionare l'opzione Modifica dal menu
azione (puntini di sospensione verticali) per specificare un valore per le tabelle.
• Seleziona l'opzione Includi se si desidera utilizzare tale tabella come parametro di esportazione o

importazione.
• Seleziona la scheda Importa per utilizzare una tabella come parametro di importazione oppure

seleziona la scheda Esporta per utilizzare una tabella come parametro di esportazione.
• Seleziona la scheda Tabella per selezionare una variabile tabella contenente i valori che si desidera

importare in BAPI. In alternativa, seleziona la scheda Stringhe per specificare manualmente il
valore.

• Seleziona l'opzione Inizia sequenza, se si desidera eseguire la BAPI in una sequenza particolare per
contrassegnare l'inizio di un processo.

• Seleziona l'opzione Termina sequenza per contrassegnare la fine di un processo.
• Seleziona l'opzione Esegui commit transazione per confermare le modifiche apportate durante il

processo.
• In the SAP BAPI Session field, enter the session name you used to connect to the  application in the

Connect .
• Nel campo Salva strutture e scalari esportati, specifica una variabile dizionario.
• Nel campo Salva tabelle esportate, specifica una variabile dizionario.

Run custom workflow action
The Run custom workflow action in the SAP BAPI package enables you to run a custom workflow in SAP
BAPI.

Impostazioni

Nota:  Adding a custom workflow is currently not supported in Automation 360. You can use the Remote
function call (RFC) to execute the custom BAPI.

• Seleziona il flusso di lavoro personalizzato che si desidera eseguire dall'elenco Seleziona flusso di
lavoro personalizzato.
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• La sezione Importa in BAPI visualizza i parametri di importazione per il flusso di lavoro selezionato.
È possibile selezionare l'opzione Modifica dal menu azione (puntini di sospensione verticali) per
specificare un valore per i parametri.
• Seleziona l'opzione Includi se si desidera utilizzare quel parametro di importazione.
• Seleziona la scheda Tabella per selezionare una variabile tabella contenente i valori che si desidera

importare in BAPI. In alternativa, seleziona la scheda Stringhe per specificare manualmente il
valore.

• Nella sezione Esporta in BAPI vengono visualizzati i parametri di esportazione per il flusso di lavoro
selezionato. È possibile selezionare l'opzione Modifica dal menu azione (puntini di sospensione
verticali) per specificare un valore per i parametri.
• Seleziona l'opzione Includi se si desidera utilizzare quel parametro di esportazione.

• La sezione Tabelle visualizza le tabelle che è possibile utilizzare come parametri di esportazione o
importazione per il flusso di lavoro selezionato. È possibile selezionare l'opzione Modifica dal menu
azione (puntini di sospensione verticali) per specificare un valore per le tabelle.
• Seleziona l'opzione Includi se si desidera utilizzare tale tabella come parametro di esportazione o

importazione.
• Seleziona la scheda Importa per utilizzare una tabella come parametro di importazione oppure

seleziona la scheda Esporta per utilizzare una tabella come parametro di esportazione.
• Seleziona la scheda Tabella per selezionare una variabile tabella contenente i valori che si desidera

importare in BAPI. In alternativa, seleziona la scheda Stringhe per specificare manualmente il
valore.

• Seleziona l'opzione Inizia sequenza, se si desidera eseguire la BAPI in una sequenza particolare per
contrassegnare l'inizio di un processo.

• Seleziona l'opzione Termina sequenza per contrassegnare la fine di un processo.
• Seleziona l'opzione Esegui commit transazione per confermare le modifiche apportate durante il

processo.
• In the SAP BAPI Session field, enter the session name you used to connect to the  application in the

Connect .
• Nel campo Salva strutture e scalari esportati, specifica una variabile dizionario.
• Nel campo Salva tabelle esportate, specifica una variabile dizionario.

Screen package
Use the Screen package to automate the process of capturing screenshots. Using the actions in this
package, you can capture an area of an application window, the entire computer screen, or an active open
window and save it in a specified location in an image format.

Actions nel package Screen

Il package Screen include le seguenti actions:

Action Descrizione

Acquisisci l’area Consulta Using Capture area action from Screen package alla pagina 1839.

Acquisisci screenshot Consulta Capture desktop action in Screen alla pagina 1841.

Acquisisci la finestra Consulta Using Capture window action from Screen package alla pagina 1841.
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Registrazione sicura

Quando la modalità di registrazione sicura è abilitata, i bots non visualizzano le immagini dell'oggetto di
destinazione dopo l'acquisizione. Questo assicura che i dati sensibili non vengano mostrati.

Nota:  Anche se i bots non visualizzino le immagini di destinazione dopo l'acquisizione, le immagini sono
ancora memorizzate nella Control Room perché sono necessarie per eseguire i bots.

Quando registri un'attività in modalità di registrazione sicura, la finestra Anteprima mostra
temporaneamente un'immagine dell'area acquisita. Questa immagine è nascosta quando ti allontani dalla
finestra Bot editor o la aggiorni.
Questa impostazione deve essere abilitata da un utente con privilegi di amministratore. Consulta
Impostazioni alla pagina 2721.
Riferimenti correlati
Screen resolution dependent packages alla pagina 2730
The screen resolution between the Bot Runner and Bot Creator device should be consistent as when
resolution-dependent packages are used to build bots, any screen resolution difference between the Bot
Creator and Bot Runner device will impact the bots during runtime.

Using Capture area action from Screen package
Use the Capture area action in the Screen package to capture a screenshot of the application window
area.
To capture a specified area of an application window, perform these steps:
1. In the Actions palette, double-click or drag the Capture area action from the Screen package.
2. Specify the window in which to capture an object.

Choose from the Application, Browser, or Variable tab.
Opzione Descrizione

Applicazione Select from a list of currently active windows.
This option shows a list of all the application
and browser windows that are open on the Bot
Creator device.

Browser Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based
, and  browsers. For all other browsers, use the
Application option.

Variabile seleziona una variabile finestra esistente per
specificare il titolo del titolo della finestra
dell'applicazione.

3. Opzionale: Inserisci un carattere jolly (*) nel campo Titolo della finestra per cercare i titoli delle
finestre che possono cambiare. You can specify one or more wildcards (*) at the start, middle, or end
of the value.
For example, to perform an operation on any window that has Microsoft in the title, use a wildcard
to indicate any string by adding it before or after the value: *Microsoft*. The  first searches for
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the exact window title (Microsoft), and if it does not find a match, it searches for windows with the
term Microsoft anywhere in the title.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

Nota:  During runtime, verify that the TaskBot identifies the correct window. If it does not, do the
following:
a. Open the application or browser window.
b. Trascina l'action Finestra > Ottieni titolo della finestra attiva sull'action Registratore >

Acquisisci.
c. Inserisci una variabile stringa nel campo Assegna il titolo della finestra a una variabile.
d. Trascina l'action Finestra > Imposta titolo sotto l'action Finestra > Ottieni titolo della

finestra attiva.
e. Nel campo Finestra, inserisci la variabile della finestra generata dall'action Registratore >

Acquisisci.
f. Nel campo Nuovo titolo della finestra, inserisci la variabile stringa dall'action Ottieni titolo

della finestra attiva.
g. Fai clic su Salva.
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4. Opzionale: Seleziona l'opzione Ridimensiona finestra per specificare le dimensioni della finestra.
This option delivers a more reliable bot. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the botto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Nota:  This option is available only for windows that can be resized. Non è disponibile per le opzioni
Desktop o Barra dei comandi.

5. Click the Capture region.
The pixel coordinates of the captured area are displayed in the X, Y, Width, and Height fields. You
can modify these values.

6. Browse to select the File path to save image.
The following file extensions are supported: png, bmp, jpeg, tiff, gif, and wmf.

7. Click Overwrite file to replace an existing file with the same name.
8. Fai clic su Salva.

Capture desktop action in Screen
The Capture desktop action in the Screen package enables you to capture an image of the entire
desktop.

Impostazioni

• In the File path to save image field, specify the path where you want to save the captured image.
The following file extensions are supported: png, bmp, jpeg, jpg, tiff, gif, and wmf.

• Select Overwrite File check box to overwrite an existing file with the same name.

Using Capture window action from Screen package
Use the Capture window action of the Screen package to capture an open application window.
To capture an application window, perform these steps:
1. In the Actions palette, double-click or drag the Capture window action from the Screen package.
2. Specify the window in which to capture an object.

Choose from the Application, Browser, or Variable tab.
Opzione Descrizione

Applicazione Select from a list of currently active windows.
This option shows a list of all the application
and browser windows that are open on the Bot
Creator device.

Browser Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based
, and  browsers. For all other browsers, use the
Application option.
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Opzione Descrizione

Variabile seleziona una variabile finestra esistente per
specificare il titolo del titolo della finestra
dell'applicazione.

3. Opzionale: Inserisci un carattere jolly (*) nel campo Titolo della finestra per cercare i titoli delle
finestre che possono cambiare. You can specify one or more wildcards (*) at the start, middle, or end
of the value.
For example, to perform an operation on any window that has Microsoft in the title, use a wildcard
to indicate any string by adding it before or after the value: *Microsoft*. The  first searches for
the exact window title (Microsoft), and if it does not find a match, it searches for windows with the
term Microsoft anywhere in the title.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
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you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

Nota:  During runtime, verify that the TaskBot identifies the correct window. If it does not, do the
following:
a. Open the application or browser window.
b. Trascina l'action Finestra > Ottieni titolo della finestra attiva sull'action Registratore >

Acquisisci.
c. Inserisci una variabile stringa nel campo Assegna il titolo della finestra a una variabile.
d. Trascina l'action Finestra > Imposta titolo sotto l'action Finestra > Ottieni titolo della

finestra attiva.
e. Nel campo Finestra, inserisci la variabile della finestra generata dall'action Registratore >

Acquisisci.
f. Nel campo Nuovo titolo della finestra, inserisci la variabile stringa dall'action Ottieni titolo

della finestra attiva.
g. Fai clic su Salva.

4. Opzionale: Seleziona l'opzione Ridimensiona finestra per specificare le dimensioni della finestra.
This option delivers a more reliable bot. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the botto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Nota:  This option is available only for windows that can be resized. Non è disponibile per le opzioni
Desktop o Barra dei comandi.

5. Browse to select the File path to save image.
The following file extensions are supported: png, bmp, jpeg, tiff, gif, and wmf.

6. Click Overwrite file to replace an existing file with the same name.
7. Fai clic su Salva.

Service package
Use the Service package to automate operations in Windows and application services including starting,
stopping, pausing, resuming, or getting the status of services.

Nota:  You must have administrator privileges to start, stop, pause, or resume service operations.

Actions nel package Services

Il package Services include le seguenti actions:
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Action Descrizione

Ottieni stato servizio Vedi Get service status action in Services alla pagina
1844

Sospendi servizio Vedi Pause service action in Services alla pagina
1844

Riprendi servizio Vedi Resume service action in Services alla pagina
1844

Avvia servizio Vedi Start service action in Services alla pagina
1844

Arresta servizio See Stop service action in Services alla pagina
1845.

Pause service action in Services
The Pause service action in the Services package enables you to pause a Windows or application service
that is currently running.

Impostazioni

Select the Service list or Variable option to enter the name of the service that you want to pause.

Resume service action in Services
The Resume service action in the Services enables you to resume a selected Windows or application
service that was previously paused.

Impostazioni

Select the Service list or Variable option to enter the name of the service that you want to resume the
services for.

Start service action in Services
The Start service action in the Services package enables you to start a selected Windows or application
service that is not running.

Impostazioni

Select the Service list or Variable option to enter the name of the service that you want to start the
service for.

Get service status action in Services
The Get service status action in the Services enables you to retrieve the current status of a Windows or
application service.
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Impostazioni

• Select either the Service list or the Variable option and to enter the name of the service that you
want to get the status for.

• Select an appropriate variable that you can assign the status value to from the Assign the output to
an existing variable option.

Esempio: The Windows Audio service status might be running.

Stop service action in Services
The Stop service action in the Services package enables you to stop a selected Windows or application
service that is currently running.

Impostazioni

Select the Service list or Variable option to enter the name of the service that you want to stop the
service for.

ServiceNow package
ServiceNow is a leading software provider of digital work flows for enterprise operations. The Automation
360 ServiceNow command package uses the ServiceNow APIs to let you build and deploy bots in
Automation 360 that work with records and triggers in ServiceNow.
This package provides actions to authenticate with ServiceNow and perform several actions with records
and attachments. To perform these actions in ServiceNow, Automation 360 uses these APIs:
• Table API
• Attachment API

Automation 360 bots can increase process efficiency for these types of work flows: customer account
creation and management, customer verification, employee on-boarding and off-boarding, data extraction
and migration, and claims and invoice processing. Automation 360 helps extend the core work flow
capabilities of ServiceNow so that you can automate repetitive tasks for intelligent, end-to-end automation.
This Automation 360 command package enables Automation 360 bots and processes to use ServiceNow
API features natively within the Automation 360 platform.

ServiceNow Triggers

You can use the ServiceNow triggers to start Automation 360 bots to respond to the events in ServiceNow
such as incident creation, updates, and so on. For more information on ServiceNow triggers, see
ServiceNow New Record trigger alla pagina 2216 and ServiceNow Updated Record trigger alla pagina 2216.
The following video shows the interaction between Automation 360 and ServiceNow when you use
ServiceNow command package:

Use cases

The key use cases for this package include:
• Create, read, update, and delete records from a ServiceNow table.
• Add, download, and delete attachments on ServiceNow records.
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• Streamline Incident responses.
• Trigger specific automations from the creation of new Incidents or Incident updates.

Prerequisiti

• The bot creator must have access to a ServiceNow account with required permissions to perform tasks
enabled by this package. Consulta Roles.

• Follow ServiceNow guidelines for authenticating to external client with OAuth 2.0. Consulta Setup OAuth.
• Create a Developer account and Developer instance in ServiceNow. Consulta Personal Developer

Instances.

Autenticazione
Use the Authentication and Revoke Authentication action to connect or disconnect from your
ServiceNow instance.
ServiceNow authentication action
Use the Authentication action to connect to your ServiceNow instance. After the authentication is
successful, you can use other command actions to perform various operations in ServiceNow.
• You must have the Client ID and Client secret generated in your ServiceNow instance. To generate the

Client details, see Create an OAuth API endpoint for external clients.
• You must have the Bot creator role for your Automation AnywhereControl Room to use the

ServiceNow package in a bot.

You can authenticate access to ServiceNow by retrieving the authentication parameters from the
ServiceNow instance and using them in Automation 360.
1. Log in to your ServiceNow instance.
2. Click All > Application Registry.
3. Select the OAuth you created.
4. Use the Client ID and Client Secret in your Authentication action from the Control Room.
5. Log in to the Control Room.
6. Create a new bot or edit an existing bot. See Creazione del primo bot alla pagina 1059.
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7. From the Actions pane, select ServiceNow > Authentication and place it under the start of the bot
flow.

Security Information Opzione

Client ID/Client secret/ User name/
Password

Select one of the following options to specify
the Client ID/Client secret/ ServiceNow
username/ password:
• Credenziale: Enables you to use a value

in the Credential Vault that contains
information about the Client ID/Client
secret/ ServiceNow username/ password.

• Variabile: Enables you to use a
credential variable that contains
information about the Client ID/Client
secret/ ServiceNow username/ password.

• Insecure string: Enables you to enter
the Client ID/Client secret/ ServiceNow
username/ password for the ServiceNow
Authentication.

a) In the ServiceNow URL field, enter your ServiceNow instance URL.
b) (Optional) Enter the API version.
c) In the Client ID field, enter the Client ID copied from ServiceNow. In the example video below

an Insecure string is used, while you can use Credential or Variable options for better security.
d) In the Client Secret field, enter the Client Secret copied from ServiceNow.
e) Enter the ServiceNow user name.
f) Enter the ServiceNow password.
g) Enter Default as the Session name.
h) You can assign the authorization header to a variable by creating either a Multiple or Dictionary

variable.

8. Click Run to save and run your bot. Once authenticated, you can use the token to call other
ServiceNow API services.

ServiceNow revoke authentication action
Use the Revoke Authentication action to securely discard the refresh token and access token when you
do not need them anymore.

1. From the Actions pane, select ServiceNow > Authentication > Revoke Authentication and
place it under the bot flow.

2. Enter the session name and click Run.
3. After the bot runs, your ServiceNow access token is revoked.

Registrazioni
Use the Records action to perform various operations in your ServiceNow instance. You can create,
update, delete, or get records from a ServiceNow Table.
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ServiceNow create record action
Use the Create Record action to create a new data record in the ServiceNow Table app.
• Ensure that you are authenticated before calling any ServiceNow action. For more details, see

ServiceNow authentication action alla pagina 1846.
• You must create a table in your ServiceNow instance as this action only creates a new record for an

existing table entry with the data provided. For more details, see Creating a table.

1. From the Actions pane, select ServiceNow > Records > Create Record and place it in the
canvas.
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2. Specify details in the following fields:
a) Enter the Table name. You can use a standard table name available in ServiceNow, for example:

Incident. Or you can use a custom user defined table name, for example: u_test_table.

Nota:  For ServiceNow tables, ensure that you provide the Table name instead of the Label
name.

b) Enter the Fields and data to insert. Choose either Dictionary or Entry list. For this example,
Dictionary is selected.
1. Select the Type as String, Number, Datetime, or Boolean based on the data you want to insert

in the table.
2. Enter a key-value pair, where key is the ServiceNow field name and value is the data you

want to update in the field.

Nota:  The key name for a field is different from the displayed label name. You can view the
key name of the file by using one of the following options:
• In your ServiceNow developer instance, navigate to System Definition > Language

File. You can use the filter option to view fields for specific Tables. Ad esempio: Incident.
• Right-click on the field name (as shown below) to display the key name. For example:

caller_id is the key name for the field Caller.

c) Enter Default as the session name.
d) Save the record ID to a variable. For example, the record ID is saved to sys_id.
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3. Click Run to save and run your bot.
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4. Verify whether the record is created in the ServiceNow table.
a) Find the sys_id variable value in the Debug mode.
b) Replace the ID in the ServiceNow URL (as shown below) to view the latest record created.

ServiceNow delete record action
Use the Delete Record action to delete a record from a ServiceNow table.
Ensure that you are authenticated before initiating any ServiceNow action. For more details, see
ServiceNow authentication action alla pagina 1846.

1. From the Actions pane, select ServiceNow > Records > Get Record and place it in the canvas.
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2. Specify details in the following fields:
a) Table name: Enter the ServiceNow table name.
b) Record Sys_id: Enter the sys_id of the record. If the record ID is captured in a variable, you can

provide the variable name.
c) The session name displays as Default.

3. Click Run to save and run your bot. When the bot is run successfully, your record in the ServiceNow
table is deleted.

ServiceNow get record action
Use the Get Record action to retrieve a record using the record ID stored in sys_Id variable from
ServiceNow.
Ensure that you are authenticated before initiating any ServiceNow action. For more details, see
ServiceNow authentication action alla pagina 1846.

1. From the Actions pane, select ServiceNow > Records > Get Record and place it in the canvas.
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2. Specify details in the following fields:
a) Table name: Enter the ServiceNow table name.
b) Record sys_id: Enter the sys_id of the record. If the record ID is captured in a variable you can

provide the variable name.
c) Select List for the Field names (Optional) field. Enter all the fields that you want to read.
d) The session name displays as Default.
e) Save the outcome to a variable. For example, the object ID is saved to dict_GetRecordResults.

3. Click Run to save and run your bot. When the bot is run successfully, the retrieved record is stored in
the specified variable.
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ServiceNow get multiple records action
Use the Get Multiple Records action to retrieve multiple records from a ServiceNow table.
Ensure that you are authenticated before initiating any ServiceNow action. For more details, see
ServiceNow authentication action alla pagina 1846.

1. From the Actions pane, select ServiceNow > Records > Get Multiple Records and place it in the
canvas.
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2. Specify details in the following fields:
a) Table name: Enter the ServiceNow table name.
b) Select List in the List of fields to return in the response (Optional) field. Enter the Type

and Value for the fields you want to view in the response.
c) You can optionally filter the records by using name-value pair or query. For example, select

Query and specify a query parameter to retrieve records for only the queried fields. For example,
you can map the sys_id to a variable and add it as a query.

d) Specify a limit of records to view. If the Limit field is blank or set to 0, all records are returned.
Response time might vary depending on the volume of the specified Table.

e) The session name displays as Default.
f) Save the outcome to a variable. For example, the object ID is saved to

list_GetMultipleRecordsResult.
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3. Click Run to save and run your bot. When the bot is run successfully, you will retrieve all the records
from ServiceNow.

ServiceNow update record action
Use the Update Record action to update a record in ServiceNow with name-value pairs.
Ensure that you are authenticated before initiating any ServiceNow action. For more details, see
ServiceNow authentication action alla pagina 1846.

1. From the Actions pane, select ServiceNow > Records > Get Record and place it in the canvas.
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2. Specify details in the following fields:
a) Table name: Enter the ServiceNow table name.
b) Sys_id: Enter the sys_id of the record. If the record ID is captured in a variable, you can provide

the variable name.
c) In Fields and data, select Dictionary or Entry list. In the example, Dictionary is selected and

the name-value pair is specified to update the record.
d) The session name displays as Default.
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3. Click Run to save and run your bot. When the bot is run successfully, your record is updated with the
specified details.

Allegati
Use the Attachments action to upload or delete an attachment from a record in the ServiceNow table. You
can also download an attachment from a ServiceNow record.
ServiceNow add attachment action
Use the Add Attachment action to add a new attachment to the specified record in a ServiceNow Table
app.
Ensure that you are authenticated before initiating any ServiceNow action. For more details, see
ServiceNow authentication action alla pagina 1846.

1. From the Actions pane, select ServiceNow > Attachments > Add Attachment and place it in the
canvas.
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2. Specify details in the following fields:
a) Enter the Table name.

Nota:  For ServiceNow tables, ensure that you provide the Table name instead of the Label
name.

b) Select the File to be uploaded by using one of the following options:
• File Control Room: If the file exists within the Control Room folders, select this option.
• File desktop: If the file exists in your local system desktop, select this option and browse the

file path.
• Variabile: You can also store the file path as a variable.

Nota:  Maximum size of the file to upload cannot exceed 25 MB.

c) (Optional) You can enter a name in the New file name field.
d) The session name displays as Default.
e) You can assign the attachment ID to a string variable. For example, the attachment ID is saved to

str_AttachmentSysId.
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3. Click Run to save and run your bot.
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4. Verify whether the attachment is added in the ServiceNow record as shown below:

ServiceNow delete attachment action
Use the Delete Attachment action to delete an attachment from a ServiceNow record.
Ensure that you are authenticated before initiating any ServiceNow action. For more details, see
ServiceNow authentication action alla pagina 1846.

1. From the Actions pane, select ServiceNow > Attachments > Delete Attachment and place it in
the canvas.
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2. Specify details in the following fields:
a) Sys_id: Enter the attachment ID or select the variable where you stored the attachment ID.
b) The session name displays as Default.

3. Click Run to save and run your bot. When the bot is run successfully, your attachment in the
ServiceNow record is deleted.

ServiceNow get attachment action
Use the Get Attachment action to download a new attachment from the specified record in a ServiceNow
Table app.
Ensure that you are authenticated before initiating any ServiceNow action. For more details, see
ServiceNow authentication action alla pagina 1846.

1. From the Actions pane, select ServiceNow > Attachments > Get Attachment and place it in the
canvas.
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2. Specify details in the following fields:
a) Filter attachment by.

• Sys_id: Specify the attachment ID or select a variable where the attachment ID is stored.
• Associated record: Specify details of the associated record, to download the associated

attachment. You must enter the table name and the table ID.
• Query: Specify a query parameter to download the attachments. For example, you can map

the sys_id to a variable and add it as a query.

b) Enter a Destination folder path, or select a variable if the path is stored in a variable.
c) The session name displays as Default.
d) You can assign the attachment ID to a string variable. For example, the attachment ID is saved to

list_GetAttachmentResults.

3. Click Run to save and run your bot.
4. The attachment is downloaded to the specified folder path.

ServiceNow field types: Table API
The ServiceNow schema contains various fields that you can modify by using the Automation 360
ServiceNow command package. The following table lists alphabetically the supported field types and their
corresponding Automation 360 to ServiceNow actions.
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Field Type Create / Update Record Get Record

Audio Not supported Supported

Choice Supported Supported

Collection Not supported Not supported

Color Supported Supported

Condition String Limited support Supported

Conditions Supported Supported

Currency Supported Supported

Data Structure Supported Supported

Data Supported Supported

Date/Time Supported Supported

Decimal Supported Supported

Document ID Supported Supported

Domain ID Supported Supported

Due Date Supported Supported

Duration Supported Supported

Field Name Supported Supported

File Attachment Not Supported Supported

Floating Point Number Supported Supported

FX Currency Supported Supported

HTML Supported Supported

Icon Supported Supported

Image Not Supported Supported

Integer Supported Supported

IP address Supported Supported

Journal Supported Supported

Journal Input Supported Supported
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Field Type Create / Update Record Get Record

Journal List Supported Supported

Elenco Supported Supported

Long Supported Supported

Name-Value Pairs Supported Supported

Password (1 Way
Encrypted)

Supported Supported

Password (2 Way
Encrypted)

Supported Supported

Percent Complete Supported Supported

Phone Number (E164) Supported Supported

Price Supported Supported

Reference Supported Supported

Script Not Supported Supported

Script (Plain) Supported Supported

String Supported Supported

String (Full UTF-8) Supported Supported

Suggestion Supported Supported

Sys ID Supported Supported

Table Name Supported Supported

Ora Supported Supported

Translated HTML Supported Supported

Translated Text Supported Supported

True/False Supported Supported

URL Supported Supported

Video Not Supported Supported

Wiki Not Supported Supported

Workflow Supported Supported
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Simulate keystrokes package
Use the Simulate keystrokes package to simulate keystrokes in Chinese (simplified and traditional), English,
French, German, Japanese, Korean, Italian, or Spanish characters.

Automation 360 extension setting

If the bot execution takes longer when you use the Simulate keystrokes packageto simulate keystrokes in
a static page running on the Google Chrome or Microsoft Edge browser, then follow these steps to enable
the setting in the Automation 360 extension:
• Click the extensions icon at the top right corner of the browser window.
• Click the vertical ellipses next to the  plugin and select Manage extension.
• Enable the Allow access to file URLs option.
• Restart the browser and run the .

Action nel package Simulate keystrokes

Il package Simulate keystrokes include le seguenti action:

Action Descrizione

Pressione di tasti Consulta Using Keystrokes action alla pagina 1867.

Attività correlate
Build a basic bot that uses a desktop application alla pagina 2052
Build a bot that uses a conditional statement to verify that the calculator is open, then uses the calculator
to multiply two numbers. This example uses actions from the Application, If, Simulate keystrokes, Message
Box, and Window packages.

Using Keystrokes action
Use the Keystrokes action to simulate keystrokes.
Follow these steps to add a Keystrokes action:
1. In the Actions palette, double-click or drag the Keystrokes action from the Keystrokes package.
2. Specify the window in which to capture an object.

Choose from the Application, Browser, or Variable tab.
Opzione Descrizione

Applicazione Select from a list of currently active windows.
This option shows a list of all the application
and browser windows that are open on the Bot
Creator device.

Browser Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based
, and  browsers. For all other browsers, use the
Application option.
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Opzione Descrizione

Variabile seleziona una variabile finestra esistente per
specificare il titolo del titolo della finestra
dell'applicazione.

Inserisci un carattere jolly (*) nel campo Titolo della finestra per cercare i titoli delle finestre che
possono cambiare. You can specify one or more wildcards (*) at the start, middle, or end of the value.For
example, to perform an operation on any window that has Microsoft in the title, use a wildcard to
indicate any string by adding it before or after the value: *Microsoft*. The  first searches for the
exact window title (Microsoft), and if it does not find a match, it searches for windows with the term
Microsoft anywhere in the title.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or disable
the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released with 
v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be identified
only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those window
titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window title

in any , the  might encounter a run time error. To prevent the run time error, ensure that when you add
the string input as *-title, the application with the specific title is open. The asterisk (*) is just a
character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window title
in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

3. Opzionale: Seleziona l'opzione Ridimensiona finestra per specificare le dimensioni della finestra.
This option delivers a more reliable bot. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the botto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Nota:  This option is available only for windows that can be resized. Non è disponibile per le opzioni
Desktop o Barra dei comandi.
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4. In the Keystrokes, select a radio button:
• Enter keystrokes here or use the on-screen keyboard: Type or use the keyboard to enter

keystrokes.
• Select a credential: Uses a password stored in the Credential Vault.

Nota:  A new key named Return has been added to the virtual keyboard to replace the Enter
functionality and the Enter key in the Number pad has been renamed to Num Enter. As a result, the
Return key is the main Enter key on the keyboard.

5. Opzionale: : In the Delay between each keystroke in ms field, the delay time.

Nota:  The default is set to 10 milliseconds.

6. Fai clic su Salva.

SNMP package
The SNMP package allows you to automate network management tasks, such as retrieving and modifying
data, and sending notification messages.
Simple Network Management Protocol (SNMP) is used to find the network management component on one
or more computers and the managed component on multiple network devices.
The Automation Anywhere SNMP action offers powerful network management. Using this action, users can
easily monitor network devices configured with SNMP agent software. Network devices such as servers,
workstations, printers, routers, bridges, and hubs, as well as services such as Dynamic Host Configuration
Protocol (DHCP) or Windows Internet Name Service (WINS) can be monitored.

Actions nel package SNMP
Il package SNMP include le seguenti actions:

Azione Descrizione

Get Vedi Get action alla pagina 1870

Get next Vedi Get next action alla pagina 1872

Invia trap Vedi Send trap action alla pagina 1874

Set Vedi Imposta action alla pagina 1876

Walk Vedi Imposta action alla pagina 1876

Riferimenti correlati
Active Directory package alla pagina 1378
Use the Active Directory package to automate actions in the Active Directory. An Active Directory
is a directory service provided by Microsoft to assist the admin in managing users across a group or
organization.
Printer package alla pagina 1743
Use the actions in the Printer package to automate retrieving and setting the default printer and removing
a printer from the list of available printers.
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Get action
Use the Get action in the SNMP package to retrieve data of an object that is managed by SNMP agent.
1. In the Actions palette, double-click or drag the Get action from the SNMP package.
2. In the Agent field, enter details of the device on which the SNMP agent is available.
3. Click the SNMP Version drop-down menu to select one of the following options to specify the SNMP

version that must be used:
Opzione Azione

V1 Specify the community string you want to use in
the Community field.

V2C Specify the community string you want to use in
the Community field.

© 2023 Automation Anywhere. All rights reserved.     1870



    Automation Anywhere - Crea

Opzione Azione

V3 Specify the community string you want to use in
the Community field.
Click the Authentication level drop-down
menu to specify one of the following level of
authentication:
• None: Authentication will not be used.
• Authentication Only: Enables you to use

authentication only.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Credenziale: To use a value from the

Credential Vault.
(Optional) Click Pick to choose a
credential.

• Variabile: To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

• Authentication and privacy: Enables you
to use authentication and privacy.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Credenziale: To use a value from the

Credential Vault.
(Optional) Click Pick to choose a
credential.

• Variabile: To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

c. Click Privacy method drop-down menu
and select DES or AES to specify the
privacy method you want to use.

d. In the Private key field, click one of the
following tabs:
• Credenziale: To use a value from the

Credential Vault.
(Optional) Click Pick to choose a
credential.

• Variabile: To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.
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4. In the Object ID field, specify the ID of the object for which you want to retrieve details.
5. Use the Data type field to select one of the following options to specify the format in which you want

to retrieve details of the object:
• ASCII
• Hex

6. Click the SNMP advanced options drop-down menu and enter the values in the following fields:
• Timeout(ms): Specify the time (in milliseconds) for the action to wait before generating an error.
• Remote port: Specify the port number of the remote device.
• Retries: Specify the maximum number of times the action must try to retrieve the details.

7. In the Log file field, click one of the following tabs:
• File Control Room: To select a file that is available on the Control Room to store the result.

Click Choose to select a file.
• File desktop: To select a file that is available on a device to store the result.

Click Browse to locate and select a file.
• Variabile: To select a variable by specifying the file location that you want to use to store the

result.

8. Select a string variable from the Assigned to list.
9. Fai clic su Salva.

Get next action
Use the Get next action in the SNMP package to retrieve data of the next object that is managed by an
SNMP agent.
1. In the Actions palette, double-click or drag the Get next action from the SNMP package.
2. In the Agent field, enter details of the device on which the SNMP agent is available.
3. Click the SNMP Version drop-down menu to select one of the following options to specify the SNMP

version that must be used:
Opzione Azione

V1 Specify the community string you want to use in
the Community field.

V2C Specify the community string you want to use in
the Community field.
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Opzione Azione

V3 Specify the community string you want to use in
the Community field.
Click the Authentication level drop-down
menu to specify one of the following level of
authentication:
• None: Authentication will not be used.
• Authentication Only: Enables you to use

authentication only.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Credenziale: To use a value from the

Credential Vault.
(Optional) Click Pick to choose a
credential.

• Variabile: To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

• Authentication and privacy: Enables you
to use authentication and privacy.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Credenziale: To use a value from the

Credential Vault.
(Optional) Click Pick to choose a
credential.

• Variabile: To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

c. Click Privacy method drop-down menu
and select DES or AES to specify the
privacy method you want to use.

d. In the Private key field, click one of the
following tabs:
• Credenziale: To use a value from the

Credential Vault.
(Optional) Click Pick to choose a
credential.

• Variabile: To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.
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4. In the Object ID field, specify the ID of the object for which you want to retrieve details.
5. Use the Data type field to select one of the following options to specify the format in which you want

to retrieve details of the object:
• ASCII
• Hex

6. Click the SNMP advanced options drop-down menu and enter the values in the following fields:
• Timeout(ms): Specify the time (in milliseconds) for the action to wait before generating an error.
• Remote port: Specify the port number of the remote device.
• Retries: Specify the maximum number of times the action must try to retrieve the details.

7. In the Log file field, click one of the following tabs:
• File Control Room: To select a file that is available on the Control Room to store the result.

Click Choose to select a file.
• File desktop: To select a file that is available on a device to store the result.

Click Browse to locate and select a file.
• Variabile: To select a variable by specifying the file location that you want to use to store the

result.

8. Select a string variable from the Assigned to list.
9. Fai clic su Salva.

Send trap action
Use the Send trap action in the SNMP package to send messages to the SNMP manager from an SNMP
agent. These messages are sent by an SNMP agent whenever certain events occur, such as a system
restart.
1. In the Actions palette, double-click or drag the Send trap action from the SNMP package.
2. In the Agent field, enter details of the device on which the SNMP agent is available.
3. Click the SNMP Version drop-down menu to select one of the following options to specify the SNMP

version that must be used:
Opzione Azione

V1 Specify the community string you want to use in
the Community field.

V2C Specify the community string you want to use in
the Community field.
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Opzione Azione

V3 Specify the community string you want to use in
the Community field.
Click the Authentication level drop-down
menu to specify one of the following level of
authentication:
• None: Authentication will not be used.
• Authentication Only: Enables you to use

authentication only.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Credenziale: To use a value from the

Credential Vault.
(Optional) Click Pick to choose a
credential.

• Variabile: To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

• Authentication and privacy: Enables you
to use authentication and privacy.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Credenziale: To use a value from the

Credential Vault.
(Optional) Click Pick to choose a
credential.

• Variabile: To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

c. Click Privacy method drop-down menu
and select DES or AES to specify the
privacy method you want to use.

d. In the Private key field, click one of the
following tabs:
• Credenziale: To use a value from the

Credential Vault.
(Optional) Click Pick to choose a
credential.

• Variabile: To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.
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4. In the Object ID field, specify the ID of the object for which you want to retrieve details.
5. Opzionale: In the Authorative ID field, specify the ID of the SNMP manager that will receive the

notification.

Importante:  If you have selected V3 from the SNMP Version list, you must provide a value for
Authorative ID.

6. Select an option from the Select trap type list to specify the type of trap you want to send.
• Cold start: Occurs when the SNMP agent initializes its configuration tables.
• Warm start: Occurs when the SNMP agent reinitializes its configuration tables.
• Link down: Occurs when the state of a network adapter on the SNMP agent changes from up to

down.
• Link up: Occurs when the state of a network adapter on the SNMP agent changes from down to

up.
• Authentication fail: Occurs when the SNMP agent receives a message from an SNMP manager

with an invalid community name.
• EGP neighbour loss: Occurs when the SNMP agent cannot communicate with its Exterior

Gateway Protocol (EGP) peer.
• Enterprise specific: Occurs when specific error conditions and error codes are defined in the

system. The user provides a trap-specific number for this option.

7. Click the SNMP advanced options drop-down menu and enter the values in the following fields:
• Timeout(ms): Specify the time (in milliseconds) for the action to wait before generating an error.
• Remote port: Specify the port number of the remote device.
• Retries: Specify the maximum number of times the action must try to retrieve the details.

8. In the Log file field, click one of the following tabs:
• File Control Room: To select a file that is available on the Control Room to store the result.

Click Choose to select a file.
• File desktop: To select a file that is available on a device to store the result.

Click Browse to locate and select a file.
• Variabile: To select a variable by specifying the file location that you want to use to store the

result.

9. Fai clic su Salva.

Imposta action
Use the Set action in the SNMP package to set a value for an object managed by the SNMP agent.
1. In the Actions palette, double-click or drag the Set action from the SNMP package.
2. In the Agent field, enter details of the device on which the SNMP agent is available.
3. Click the SNMP Version drop-down menu to select one of the following options to specify the SNMP

version that must be used:
Opzione Azione

V1 Specify the community string you want to use in
the Community field.

V2C Specify the community string you want to use in
the Community field.
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Opzione Azione

V3 Specify the community string you want to use in
the Community field.
Click the Authentication level drop-down
menu to specify one of the following level of
authentication:
• None: Authentication will not be used.
• Authentication Only: Enables you to use

authentication only.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Credenziale: To use a value from the

Credential Vault.
(Optional) Click Pick to choose a
credential.

• Variabile: To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

• Authentication and privacy: Enables you
to use authentication and privacy.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Credenziale: To use a value from the

Credential Vault.
(Optional) Click Pick to choose a
credential.

• Variabile: To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

c. Click Privacy method drop-down menu
and select DES or AES to specify the
privacy method you want to use.

d. In the Private key field, click one of the
following tabs:
• Credenziale: To use a value from the

Credential Vault.
(Optional) Click Pick to choose a
credential.

• Variabile: To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

© 2023 Automation Anywhere. All rights reserved.     1877



    Automation Anywhere - Crea

4. In the Object ID field, specify the ID of the object for which you want to retrieve details.
5. From the Value type list, select an option to specify the value you want to set.

• OctetString
• Integer
• Gauge
• TimeTicks
• IP
• ObjectID
• OctetByteString
• OctetDecimalByteString
• NULL

6. In the Set value field, specify the value you want to set.
7. Click the SNMP advanced options drop-down menu and enter the values in the following fields:

• Timeout(ms): Specify the time (in milliseconds) for the action to wait before generating an error.
• Remote port: Specify the port number of the remote device.
• Retries: Specify the maximum number of times the action must try to retrieve the details.

8. In the Log file field, click one of the following tabs:
• File Control Room: To select a file that is available on the Control Room to store the result.

Click Choose to select a file.
• File desktop: To select a file that is available on a device to store the result.

Click Browse to locate and select a file.
• Variabile: To select a variable by specifying the file location that you want to use to store the

result.

9. Fai clic su Salva.

Walk action
Use the Walk action in the SNMP package to set up a collection of information about all the devices
available on all the connected nodes or subtree.
1. In the Actions palette, double-click or drag the Walk action from the SNMP package.
2. In the Agent field, enter details of the device on which the SNMP agent is available.
3. Click the SNMP Version drop-down menu to select one of the following options to specify the SNMP

version that must be used:
Opzione Azione

V1 Specify the community string you want to use in
the Community field.

V2C Specify the community string you want to use in
the Community field.
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Opzione Azione

V3 Specify the community string you want to use in
the Community field.
Click the Authentication level drop-down
menu to specify one of the following level of
authentication:
• None: Authentication will not be used.
• Authentication Only: Enables you to use

authentication only.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Credenziale: To use a value from the

Credential Vault.
(Optional) Click Pick to choose a
credential.

• Variabile: To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

• Authentication and privacy: Enables you
to use authentication and privacy.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Credenziale: To use a value from the

Credential Vault.
(Optional) Click Pick to choose a
credential.

• Variabile: To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

c. Click Privacy method drop-down menu
and select DES or AES to specify the
privacy method you want to use.

d. In the Private key field, click one of the
following tabs:
• Credenziale: To use a value from the

Credential Vault.
(Optional) Click Pick to choose a
credential.

• Variabile: To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

© 2023 Automation Anywhere. All rights reserved.     1879



    Automation Anywhere - Crea

4. In the Object ID field, specify the ID of the object for which you want to retrieve details.
5. Use the Data type field to select one of the following options to specify the format in which you want

to retrieve details of the object:
• ASCII
• Hex

6. In the Walk type section, select an option to specify the scope from which to collect information.
• Tutti: Displays the variables that are equal to the specified OID for the given tree type structure.
• Within: All variables in the sub-tree below the given OID are queried.

7. Click the SNMP advanced options drop-down menu and enter the values in the following fields:
• Timeout(ms): Specify the time (in milliseconds) for the action to wait before generating an error.
• Remote port: Specify the port number of the remote device.
• Retries: Specify the maximum number of times the action must try to retrieve the details.

8. In the Log file field, click one of the following tabs:
• File Control Room: To select a file that is available on the Control Room to store the result.

Click Choose to select a file.
• File desktop: To select a file that is available on a device to store the result.

Click Browse to locate and select a file.
• Variabile: To select a variable by specifying the file location that you want to use to store the

result.

9. Select a string variable from the Assigned to list.
10. Fai clic su Salva.

SOAP Web Service package
Use the SOAP web service action from the SOAP Web Service package to access and exchange
information between two systems in XML format.
With SOAP Web Service, you can perform these actions:
• Consume SOAP web services written to provide structured data for further business processing, such as

currency conversion, weather reports, and language translation.
• Connect to different existing applications and different platforms, irrespective of any underlying

infrastructure requirements.

The SOAP Web Service establishes complete interoperability between clients or applications and the
internet, supporting XML-based open standards, such as Web Services Description Language (WSDL),
Simple Object Access Protocol (SOAP), and Universal Description Discovery and Integration (UDDI).

Passaggio dei valori in modo sicuro

Puoi passare in modo sicuro i valori dal Credential Vault al servizio web specificando locker, le credenziali e
l'attributo nei seguenti campi action supportati:
• Intestazioni personalizzate
• Parametri operazione
• Raw data: You must select a Credential Vault value that contains the entire parameter as the value.
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Supporto proxy

Se il dispositivo è configurato con un proxy, tutte le richieste in uscita da questo package vengono
instradate tramite il server proxy. Consulta Connettere Bot Agent a un dispositivo con un proxy alla pagina
1046.

Nota:  For an example task about using the SOAP Web Service action, see Esempio di utilizzo dell'azione
Servizio Web SOAP alla pagina 2076.

Attività correlate
Example of building a bot that uses credential variables alla pagina 2042
Securely pass values to a bot using credential variables to automate the process of logging in to a bank
website.
Riferimenti correlati
Credentials and credential variables in the Bot editor alla pagina 2039
Use credentials when building bots to pass sensitive information such as passwords and account numbers.
Using credentials separates the sensitive information from the bots and Bot Runners, which reduces the
risk of data spillage or unauthorized user access.

Step package
The Step package groups various actions together and runs them in a specific order. You can provide a
relevant name for a step to identify the operation performed by the actions included in that step.

Action nel package Step

Il package Step include le seguenti action:

Action Descrizione

Passaggio Runs a sequence of actions.
• Creates a container for actions without impacting the bot run.
• Configures actions within the Step action.
• Runs the arranged actions in a sequential order.
• Groups various actions for better management.
• Optional: In the Title field, specify the title.

String package
Utilizza il package String per eseguire varie operazioni come il confronto tra due stringhe, il recupero della
lunghezza della stringa o la conversione di una stringa in lettere maiuscole o minuscole.

Actions nel package String

Il package String include le seguenti actions:

Action Descrizione

Assegna Assign action alla pagina 1882
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Action Descrizione

Estrai testo Using Extract text action of String package alla pagina 1883

Confronta Compare action alla pagina 1886

Evaluate variable Evaluate variable action alla pagina 1886

Trova Using Find action of String package alla pagina 1886

Lunghezza Length action alla pagina 1887

Minuscolo Lowercase action alla pagina 1887

Genera stringa casuale Generate random string action alla pagina 1887

Replace Using Replace action alla pagina 1888

Inverti Reverse action alla pagina 1888

Dividi Using Split action alla pagina 1889

Estrai sottostringa Substring action alla pagina 1889

To boolean To boolean action alla pagina 1889

Al numero locale To locale number action alla pagina 1890

To number To number action alla pagina 1890

Taglia Trim action alla pagina 1890

Maiuscolo Uppercase action alla pagina 1890

Importa stringa da file
di testo

Import string from text file action alla pagina 1891

Attività correlate
Using Extract text action of String package alla pagina 1883
Puoi utilizzare l'action Estrai testo per estrarre un intervallo di testo utilizzando gli operatori logici dalla
stringa sorgente.
Using Find action of String package alla pagina 1886
Use the Find action to find a substring within the specified string.
Using Replace action alla pagina 1888
Use the Replace action to find a piece of text from the source string and replace it with another text.
Using Split action alla pagina 1889
Use the Split action to split the specified string into multiple strings and store the output in a list variable.

Assign action
The Assign action in the String package enables you to assign or concatenate strings.
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Impostazioni

• Facoltativo: In the Select the source string variable(s)/value field, specify the variable or values.
This field holds up to 65535 alphanumeric, character, and empty values.

Nota:
• Per fornire una stringa che include il simbolo del dollaro ($), devi inserire due simboli di dollaro. For

example, if you enter Pay $$5.00, the output will be Pay $5.00.
• The values or variables that you can specify for the String package are predefined. Vedi Variabili

predefinite alla pagina 2023

• Nel campo Seleziona la variabile stringa di destinazione, specifica la variabile.

Using Extract text action of String package
Puoi utilizzare l'action Estrai testo per estrarre un intervallo di testo utilizzando gli operatori logici dalla
stringa sorgente.
Review the information in Estrai testo alla pagina 1885.
Per estrarre una sottostringa dalla stringa sorgete specificata, attieniti alla seguente procedura:
1. Nella tavolozza Actions, fai doppio clic o trascina l'action Estrai testo dal package Stringa.
2. Nel campo Stringa sorgente, specifica la stringa sorgente.
3. Specifica il testo da estrarre selezionando una delle seguenti opzioni:

Opzione Fasi

Prima Estrae l'intero testo seguito dal valore fornito nel campo Inizia dopo il
testo.
a. Nel campo Inizia dopo il testo, immetti una stringa da utilizzare

come punto di partenza.
b. Nel campo Occorrenza, immetti un valore per specificare il numero

di occorrenze.
Ad esempio, se la stringa sorgente è This is a test string
 which is used to extract specific sub-string e vuoi
estrarre l'intero testo dopo This. Per estrarre il testo richiesto, devi
immettere This nel campo Inizia dopo il testo e 1 nel campo
Occorrenza. Questo indica al sistema di estrarre il testo disponibile
dopo la prima occorrenza di This nella stringa sorgente.
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Opzione Fasi

Prima e/o dopo Estrae il testo compreso tra i valori forniti nei campi Inizia dopo il testo
e Finisci prima del testo.
a. Nel campo Inizia dopo il testo, immetti una stringa da utilizzare

come punto di partenza.
b. Nel campo O oppure E, seleziona una delle opzioni:

• O: seleziona per estrarre il testo se uno dei valori specificati
nel campo Inizia dopo il testo o Finisci prima del testo è
disponibile nella stringa sorgente.

• E: seleziona per estrarre il testo se entrambi i valori specificati
nel campo Inizia dopo il testo e Finisci prima del testo sono
disponibili nella stringa sorgente.

c. Nel campo Finisci prima del testo specifica una stringa da utilizzare
come punto finale per l'estrazione del testo.

d. Nel campo Occorrenza inserisci un valore per specificare il numero
di occorrenze della stringa specificata nel campo Finisci prima del
testo da considerare come punto finale.
Ad esempio, se la stringa sorgente è This is a test string
 which is used to extract specific substring e vuoi
estrarre l'intero testo prima di specific. Per estrarre il testo
richiesto, devi immettere specific nel campo Finisci prima
del testo e 1 nel campo Occorrenza. Questo indica al sistema
di estrarre il testo disponibile prima della prima occorrenza di
specific nella stringa sorgente.

Dopo Estrae l'intero testo che precede il valore fornito nel campo Finisci prima
del testo.
a. Nel campo Finisci prima del testo specifica una stringa da utilizzare

come punto finale per l'estrazione del testo.
b. Nel campo Occorrenza inserisci un valore per specificare il numero

di occorrenze della stringa specificata nel campo Finisci prima del
testo da considerare come punto finale.
Ad esempio, se la stringa sorgente è This is a test string
 which is used to extract specific substring e vuoi
estrarre l'intero testo prima di specific. Per estrarre il testo
richiesto, devi immettere specific nel campo Finisci prima
del testo e 1 nel campo Occorrenza. Questo indica al sistema
di estrarre il testo disponibile prima della prima occorrenza di
specific nella stringa sorgente.

4. Nel campo Se non viene trovata alcuna corrispondenza, restituisci, seleziona una delle opzioni:
• Stringa sorgente: restituisce la stringa sorgente.
• Stringa vuota (nulla): restituisce la stringa nulla se non viene trovata alcuna corrispondenza.
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5. Nel campo Durante l'estrazione, seleziona una delle seguenti opzioni:
• Caso di corrispondenza: corrisponde al caso del testo nella stringa sorgente
• Caso di non corrispondenza: non corrisponde al caso del testo nella stringa sorgente

Nota:  Per impostazione predefinita, l'opzione Caso di corrispondenza è selezionata per tutti i bots
nuovi ed esistenti.

6. Nel campo Numero di caratteri da ottenere, seleziona una delle opzioni:
• Tutti: estrae tutti i caratteri dalla stringa sorgente.
• Solo: specifica il numero di caratteri da estrarre dalla stringa sorgente.

7. Nella casella di controllo Taglia il testo estratto (rimuovi spazi bianchi) seleziona per rimuovere
gli spazi vuoti dal testo estratto.

8. Nella casella di controllo Rimuovi Inserisci da testo estratto seleziona per rimuovere i ritorni a
capo dal testo estratto.

9. Nell'elenco Assegna l'output alla variabile, specifica la variabile.
10. Fai clic su Salva.

Estrai testo
The Extract text action enables you to extract text from a source string. You can extract text that occurs
in the range of 1 to 999999 times in a file before, after, or between two strings.

Using the After Option

This option enables you to extract the entire text followed by the value you have provided in the Start
after text field. You can also extract the text based on the occurrence of the value you have provided in
the field.
For example, a:123a:123b:123c: is the source string, you can specify ':' in the Start after text field
and '2' in the Occurrence field to extract the string followed by the second occurrence of ':' in the source
string. In this example, the extracted text is '123b:123c:'.

Using the Before Option

This option enables you to extract the entire text preceding the value you have provided in the End
before text field. You can also extract the text based on the occurrence of the value you have provided in
the field.

Nota:  You can extract text that occurs more than 1000 times in a file and up to a maximum of 999999
times.

For example, a:123a:123b:123c: is the source string, you can specify ':' in the End before text field
and '3' in the Occurrence field to extract the string preceding the third occurrence of ':' in the source
string. In this example, the extracted text is 'a:123a:123b'.

Using the Before and/or after option

This option enables you to extract the text between the values you have provided in the Start after text
and the End before text fields. You can also apply the AND or OR logical operator. You can select the
AND operator to extract text only when both conditions specified for the Before and After options are
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satisfied. Otherwise, you can select the OR operator to extract text only when either of the conditions
specified for the Before or the After option is satisfied.
For example, a:123a:123b:123c: is the source string, you can specify ':' in the Start after text and
End before text fields and '2' in the Occurrence fields to extract the string after the second and before
the fourth occurrence of ':' in the source string. In this example, the extracted text is '123b:123c'.

Compare action
The Compare action in the String package enables you to compare two strings.

Impostazioni

• Nel campo Stringa sorgente, specifica la stringa sorgente.
• In the Compare to string field, specify the string that the source has to be compared with.
• Nel campo Nel confrontare, seleziona un'opzione:

• Caso di corrispondenza: Matches capitalization.
• Caso di non corrispondenza: Does not match capitalization.

• Nell'elenco Assegna l'output alla variabile, specifica la variabile booleana.

Evaluate variable action
The Evaluate variable action in the String package enables you to compare the user-specified string
variable with the string variables in the bot and if a match is found, the action returns the value of the
matching variable.

Impostazioni

• Inserisci la variabile stringa da cercare.
• Nel campo Assegna il valore a una variabile, seleziona una variabile stringa per contenere il valore

restituito.

Esempio:
1. Create a variable of type string whose value you want to evaluate and name it var1. Here the value

of the variable var1 is $cityname$ and $cityname$ has the value Paris.
2. Enter $var1$ in the Variable expression field.
3. On bot execution, the user specified string variable $var1$ now searches among the variables

defined in the bot for the string variable $cityname$ and if the match is found then the action
returns the output value of the matched variable $cityname$, that is, Paris.

Nota:  This action can evaluate only string variables and up to one level of nesting.

Using Find action of String package
Use the Find action to find a substring within the specified string.
This action also enables you to perform a search based on a regular expression. A regular expression
is a sequence of characters that define a search pattern. For example, to find all email addresses in the
source string, specify the following as a regular expression: \b[A-Z0-9._%-]+@[A-Z0-9.-]+\.[A-Z]
{2,4}\b.
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Nota:  To search for strings that contain the dollar sign ($), you must enter the sign twice. Otherwise, the
bot interprets the dollar sign as a regular expression character.

To find a substring from the specified string, follow these steps:
1. In the Actions palette, double-click or drag the Find action from the String package.
2. Nel campo Stringa sorgente, specifica la stringa sorgente.
3. In the Find string field, specify the substring.
4. In the When finding field, select one of the options:

• Caso di corrispondenza: Matches the case of the text.
• Caso di non corrispondenza: Does not match the case of the text.

5. In the The "find string" is field, select one of the options:
• A regular expression: The substring is a regular expression
• Not a regular expression: The substring is not a regular expression.

6. Opzionale: Nel campo Inizia da, specifica il punto iniziale.
For example, you want to replace Red in the source string with Blue in a paragraph. Red is in 10
instances in the paragraph and you want to replace only the third occurrence. Enter 3 in the Start
from field to identify the third occurrence.

7. In the Assign the output to variable list, specify the number variable.
8. Fai clic su Salva.

Length action
The Length action in the String package enables you to retrieves the string length.

Impostazioni

• Nel campo Stringa sorgente, specifica la stringa sorgente.
• Nell'elenco Assegna l'output alla variabile, specifica la variabile numero.

Lowercase action
The Lowercase action in the String package enables you to convert the source string to lowercase.

Impostazioni

• Nel campo Stringa sorgente, specifica la stringa sorgente.
• Nell'elenco Assegna l'output alla variabile, specifica la variabile.

Generate random string action
The Generate random string action in the String package enables you to generate a string of uppercase
and lowercase alphanumeric characters and assign it to a string variable.

Impostazioni

• Nel campo Lunghezza stringa, immetti il numero di caratteri nella stringa generata.
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Nota:  The maximum number of characters is 300.

• In the Enter the destination variable to assign the random string field, specify the string
variable.

Using Replace action
Use the Replace action to find a piece of text from the source string and replace it with another text.
A regular expression is a sequence of characters that define a search pattern. For example, to find all email
addresses in the source string, specify the following as a regular expression: \b[A-Z0-9._%-]+@[A-
Z0-9.-]+\.[A-Z]{2,4}\b.

Nota:  The Replace action might not replace the Carriage Return and Line Feed (CRLF) characters in a
string when you use the Enter variable. To ensure that the characters are replaced, instead of the Enter
variable, use the Newline variable.

To replace text from the specified string, follow these steps:
1. In the Actions palette, double-click or drag the Replace action from the String package.
2. Nel campo Stringa sorgente, specifica la stringa sorgente.
3. In the Find string field, specify the substring.
4. In the When finding field, select one of the options:

• Caso di corrispondenza: Matches the case of the text.
• Caso di non corrispondenza: Does not match the case of the text.

5. In the The "find string" is field, select one of the options:
• A regular expression: The substring is a regular expression
• Not a regular expression: The substring is not a regular expression.

6. Opzionale: In the Start from field, specify the starting position.
The action then starts from the value you specify in this field. For example, if you specify 5 in the
Start from field for the source string "Big blue ocean", when the bot runs, the action ignores the four
preceding characters ("Big", including the space character) and searches for the substring in "blue
ocean".

7. Opzionale: In the Count field, specify the number of times the found string must be replaced.
For example, in the source string "Big blue ocean, blue fish, blue sky", you want to replace the first
two instances of "blue" with "green". Enter 2 in the Count field, 5 in the Start from field, and green
in the Replace with field. When the bot runs, the action produces the output green ocean,
 green fish, blue sky.

Nota:  By default, the value in the Count field is set to -1, which means that all the instances of the
found string will be replaced.

8. In the Replace with field, specify the text to replace the string.
9. In the Assign the output to variable list, specify the variable that will hold the new string.
10. Fai clic su Salva.

Reverse action
The Reverse action in the String package enables you to reverse the source string.
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Impostazioni

• Nel campo Stringa sorgente, specifica la stringa sorgente.
• Nell'elenco Assegna l'output alla variabile, specifica la variabile.

Using Split action
Use the Split action to split the specified string into multiple strings and store the output in a list variable.
To split a string into multiple strings, perform these steps:
1. In the Actions palette, double-click or drag the Split action from the String package.
2. Nel campo Stringa sorgente, specifica la stringa sorgente.
3. In the Delimiter field, specify the character to split the string.

For example, comma (,), semicolon (;), pipe (|), slash (/ \), newline character (\n), or space.
In the delimiter text box, the newline character is not accepted for the Enter key as a line break.
In that case, you can either press F2 and select Enter - String from String section or input the
$String:Enter$ variable.

4. In the Delimiter is field, select one of the options:
• Case sensitive: The delimiter is case-sensitive.
• Not case sensitive: The delimiter is not case-sensitive.

5. In the Split into substrings field, select one of the options:
• All possible: Splits the source string into as many substrings as possible.

For example, if the original string is a,b,c,d, each character becomes a substring.
• Solo: Limits the number of substrings.

For example, if the original string is a,b,c,d, and you enter 3, the output is three strings: a, b, and
c,d.

6. In the Assign the output to list variable field, specify the list variable.
7. Fai clic su Salva.

Substring action
The Substring action in the String package enables you to extract a substring from a string.

Impostazioni

• Nel campo Stringa sorgente, specifica la stringa sorgente.
• Nel campo Inizia da, specifica il punto iniziale.
• Facoltativo: Nel campo Lunghezza, specifica la lunghezza.
• Nell'elenco Assegna l'output alla variabile, specifica la variabile.

To boolean action
The To boolean action in the String package enables you to convert a string to a Boolean.
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Impostazioni

• In the Select string variable variable field, specify the source string variable.
• In the Select the boolean variable to store the result field, specify the Boolean variable.

To locale number action
The To locale number action in the String package enables you to convert a string to a locale-formatted
number.

Impostazioni

• Nel campo Valore sorgente, specifica la stringa sorgente.
• Seleziona una delle seguenti schede per specificare l'impostazione locale:

• Specifica: Specifica manualmente i codici ISO di due lettere per le impostazioni locali che si vuole
utilizzare nel campo Locale.

• Dispositivo: Usa l'impostazione locale predefinita configurata per il dispositivo.

• Nell'elenco Salva il risultato in una variabile, specifica la variabile.

Puoi anche utilizzare l'azione in un'espressione. Per esempio, $prompt-
assignment.String:toLocaleNumber("en-US")$.

To number action
The To number action in the String package enables you to convert a string to a number.

Impostazioni

This action supports positive, negative, and decimal numbers.

Nota:  Se la stringa contiene virgole, rimuovile utilizzando l'action Sostituisci per sostituire ogni virgola
con una stringa vuota.

• In the Enter the string field, specify the source string.
• In the Assign the output to variable field, specify the number variable.

Trim action
The Trim action in the String package enables you to trim blanks, whitespaces, tabs, and line breaks from
a string.

Impostazioni

• Nel campo Stringa sorgente, specifica la stringa sorgente.
• In Taglia dall'inizio e Taglia dalla fine, seleziona le opzioni.
• In the Assign the output to variable field, specify the variable.

Uppercase action
The Uppercase action in the String package enables you to convert the source string to uppercase.
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Impostazioni

• Nel campo Stringa sorgente, specifica la stringa sorgente.
• Nell'elenco Assegna l'output alla variabile, specifica la variabile.

Import string from text file action
The Import string from text file action in the String package enables you to import values from a
variable in a text file into a string variable.

Impostazioni

• Seleziona il file di testo dalla variabile Control Room, desktop o file.
• Nel campo Chiave variabile, specifica la variabile che contiene i valori da importare. Questo campo

non è sensibile alla distinzione tra maiuscole/minuscole.
Quando un bot esegue questa action, recupera i valori tra il segno = e l'interruzione di riga.

• Nell'elenco Assegna l'output alla variabile, specifica la variabile.

Nota:  If you built a bot using this action from the String package from Build 5322 or earlier, the action
will be missing when you open the bot with the default package version. You must reinsert the action and
repopulate the fields.

System package
Use the actions in the System package to automate locking, logging off, restarting, and shutting down the
computer. Use these actions at the end of a task.
Il package System include le seguenti actions:

Nota:  If you are on Automation 360 v.22 (Build 10526) or a later version, we recommend that you use
the Automation 360 v.22 or a later System package version to run your bots seamlessly.

Action Descrizione

Blocca computer Consulta Lock computer action alla pagina 1892.

Disconnetti Consulta Logoff action alla pagina 1892.

Riavvia Consulta Restart action alla pagina 1892.

Spegni Consulta Shutdown action alla pagina 1892.

Ottieni variabile
ambiente

Consulta Get environment variable action alla pagina 1892.

Attività correlate
Using Log to file action alla pagina 1680
The Log to file action in the Log To File package enables you to create a log file with data about the
events that occur when a TaskBot runs.
Riferimenti correlati
Application package alla pagina 1402
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Use the Open Program/File action in the Application package to launch an application or a file. This
action supports .exe, .bat, script files, or shortcut paths.

Lock computer action
The Lock computer action enables you to lock the local machine on which the bot is run.

Logoff action
The Logoff action enables you to log off from the current user session of the local machine on which the
bot is run.

Restart action
The Restart action enables you to restart the local machine on which the bot is run.

Shutdown action
The Shutdown action enables you to turn off the local machine on which the bot is run .

Get environment variable action
The Get environment variable action enables you to get all the environment variables from the
specified local machine and assign it to a variable.

Impostazioni

• (Optional) In the Environment variable list tab, click the drop-down menu and select one of the
variables.
The following table lists the variable details:

Variabile Descrizione Example value

ALLUSERSPROFILE Returns the path to the directory
that contains resources and settings
used by all system accounts.

Nota:  Use ProgramData for devices
that run Windows Vista and later
OS.

C:\ProgramData

APPDATA Returns the file path to the
application data directory. This
directory contains the settings for
applications shared across multiple
devices.

C:\Users\<user>
\AppData
\Roaming

COMPUTERNAME Returns the device name without
the domain.

AA-NY-
FRANKSINATRA

CommonProgramFiles Returns the file path to the Common
 Files directory.

C:\Program Files
\Common Files

CommonProgramFiles(x86) Returns the file path to the Common
 Files directory.

Nota:  This is only available for
devices that run 64-bit version.

C:\Program Files
(x86)\Common
Files
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Variabile Descrizione Example value

CommonProgramW6432 Returns the file path to the Common
 Files directory.

Nota:
• This is only available for devices

that run 64-bit version.
• Only use CommonProgramW6432

for devices that run Windows
Vista and later OS

C:\Program Files
\Common Files

ComSpec Returns the file path to the
command processor

C:\Windows
\system32\cmd.exe

DriverData Returns the file path to the Driver
 Data directory.

C:\Windows
\System32\Drivers
\DriverData

HOMEDRIVE Returns the home drive of the
device.

C:

HOMEPATH Returns the homepath of the device
without the system drive.

\Users\<user>

LOCALAPPDATA Returns the file path to the
application data directory. This
directory contains the settings for
applications shared across multiple
devices.

C:\Users\<user>
\AppData\Local

LOGONSERVER Returns the name of the group
or domain to which the device is
connected

\\SJCSRVBKP

NUMBER_OF_PROCESSORS Returns the number of processors in
the device.

4

OneDrive Returns the path to the OneDrive
folder.

C:\Users\<user>
\OneDrive

OS Returns the device operating system
name.

Windows_NT

Percorso Returns a semicolon-delimited list of
directories that contain executable
programs.

C:\Windows
\system32;C:
\Windows;C:
\Windows
\System32\Wbem;C:
\Windows
\System32\WindowsPowerShell
\v1.0\

PATHEXT Returns a semicolon-delimited list of
file extensions that the system can
execute.

.COM;.EXE;.BAT;.CMD;.VBS;.VBE;.JS;.JSE;.WSF;.WSH;.MSC
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Variabile Descrizione Example value

PROCESSOR_ARCHITECTURE Returns the process architecture of
the device.

AMD64

ProgramData Returns the path to the directory
that contains resources and settings
used by all system accounts.

Nota:  Use ALLUSERSPROFILE for
devices that run the Windows XP
and earlier OS.

C:\ProgramData

ProgramFiles Returns the path to the directory
that stores installed programs.

C:\Program Files

ProgramFiles(x86) Returns the path to the directory
that stores installed programs.

Nota:  This is only available for
devices that run 64-bit version.

C:\Program Files
(x86)

ProgramW6432 Returns the path to the directory
that stores installed programs.

C:\Program Files

PSModulePath Returns file paths to the modules
that are installed on the disk.

%ProgramFiles%
\WindowsPowerShell
\Modules;C:
\Windows
\system32\WindowsPowerShell
\v1.0\Modules

PUBLIC Returns the Public folder path. C:\Users\Public

SystemDrive Returns the device system drive. C:

SystemRoot Returns the system root folder. C:\Windows

TMP Returns the path to the directory
that stores temporary files.

C:\Users\<user>
\AppData\Local
\Temp

TEMP Returns the path to the directory
that stores temporary files.

C:\Users\<user>
\AppData\Local
\Temp

USERDNSDOMAIN Returns the DNS domain of the
user.

AAI.AASPL-
BRD.COM

USERDOMAIN Returns the domain of the user. AAI.AASPL-
BRD.COM

USERDOMAIN_ROAMINGPROFILE Returns the domain of the user
profile.

AAI

USERNAME Returns the logged-in user name. bob.ross

USERPROFILE Returns the user profile path. C:\Users\<user>
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Variabile Descrizione Example value

windir Returns the Windows directory
path.

C:\Windows

• (Optional) Use the Variable tab to add a value for the variable.
Click Insert a value icon if there is no existing variable.

• Click the Assign the output to an existing variable drop-down menu and select an existing
variable.
Click the Create variable icon for new variable.

Task Bot package
Utilizza Esegui, Pausa e Sospendi actions nel package Task Bot per gestire l'esecuzione di uno o più
bots figlio da un bot padre o con un software di terze parti utilizzando un'API.
Crea bots più piccoli che automatizzano un'unica attività e la eseguono da un bot padre. For example, build
a Login child bot to enter the username and password into a web form and click submit. The Login child
bot accepts credentials from the parent bot and returns a success message, and then the parent bot can
call the subsequent CreateInvoice child bot. The Login child bot should also contain error handling
logic in case the credentials are incorrect.
This practice of building smaller, self-contained bots enables a user to reuse the bot logic in a greater
number of tasks, and makes error handling and troubleshooting easier. This also decreases the amount
of time spent building and maintaining bots. As a result, an organization is able to rapidly scale their
automation initiatives. The Login child bot from this example can be reused in any task that involves
providing credentials to a login page on a website.
When you run a TaskBot that calls itself repeatedly until you choose to stop it, the bot runs infinitely and,
as a result, encounters an error related to stack memory issues. We recommend that you create a parent
and a child bot with different names and then run the child bot from the parent bot.

Nota:
• Non è possibile condividere file CSV/di testo e sessioni del registratore tra bots. È possibile condividere

le sessioni Excel tra bots utilizzando una variabile di sessione. Consulta Example of sharing an Excel
session between bots alla pagina 1899.

• Quando si utilizza una variabile tipo file in Run Task, assicurati di aver impostato il valore predefinito
nella variabile. Senza il valore predefinito, il bot visualizza un errore durante l'esecuzione.

In addition, running child bots from a parent bot offers greater control over data in the following ways:
• Users can configure the variables in the child bot to control the direction in which information can be

exchanged by selecting from the following options:
• Usa come input: The variable holds a value that the child bot accepts from a parent bot or third-

party software.
• Usa come output: The variable holds a value that the child bot passes to the parent bot or third-

party software.
• Both: The value can be passed in both directions.
• Neither: The variable is confined to this bot; it cannot be shared across other bots.

Vedi Create a variable alla pagina 2030
• Other users can reuse child bots without viewing their contents.
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Il package Task Bot include le seguenti actions:

Action Descrizione

Metti in pausa Consulta Pause action alla pagina 1896.

Esegui • See Using the Run action alla pagina 1896..
• For an example, see Example of using the Run action alla pagina 2074.

Sospendi Consulta Stop action alla pagina 1899.

Pause action
The Pause action in the Task Bot package enables you to temporarily pause the running bot.

Impostazioni

Temporarily pauses the running bot. Utilizza l'action Pausa per modificare i dati o per verificare lo stato di
un componente pertinente.
Quando il bot raggiunge l'action Pausa durante il tempo di esecuzione, viene visualizzato il pulsante
Riprendi. È necessario fare clic su Riprendi affinché il bot passi alla action successiva.

Using the Run action
L'action Esegui del package TaskBot consente di eseguire uno o più bots figli. Configure the action to run
the child bots repeatedly or with a delay, and to pass and retrieve values.
The action runs the selected task multiple times for a specified number of times or for a number of hours.
The task can be repeated until the user chooses to stop it. You can save the output values to a dictionary
variable, where each key in the dictionary is the variable name and corresponding value from the child
bot.Or, you can map each dictionary key to a variable to store the corresponding value.

Nota:  When you create a TaskBot with dependencies, ensure that the both the parent and child bot are
in the same workspace (public or private). You cannot call a public bot from a private bot. To do so, you
should first either check-out or clone the public bot into the private workspace and then check-in both the
bots to the public workspace.

1. Nella tavolozza Actions, fai doppio clic o trascina l'action Esegui dal package Task Bot.
2. Nel campo Task Bot da eseguire, seleziona il bot figlio:

Opzione Descrizione

TaskBot attuale Esegue il bot corrente in modo ricorsivo.
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Opzione Descrizione

File della Control Room Seleziona un bot che desideri eseguire:
• Fai clic sulla scheda Sfoglia se desideri

selezionare un bot dall'area di lavoro privata.
Viene visualizzata anche la posizione del bot
selezionato nell'archivio privato.

• Fai clic sulla scheda Cerca se desideri cercare
un bot nell'area di lavoro pubblica e nell'area
di lavoro privata.
I suggerimenti relativi ai bots disponibili nelle
aree di lavoro pubblica e privata vengono
visualizzati quando si inizia a digitare il
nome del bot che si desidera eseguire.
Viene visualizzata anche la posizione del bot
selezionato nelle aree di lavoro pubblica e
privata.

Variabile Scegli tra le seguenti opzioni:
• File: Inserisci una variabile di file che

contiene un bot.
• Percorso Control Room: Immetti

un'espressione che inizi con Bot e contenga
una variabile stringa per specificare il bot. Ad
esempio Bots/$department$/PTOReport.

Nota:
• Il percorso del file fa distinzione tra

maiuscole e minuscole.
• Il bot deve trovarsi nella stessa area di

lavoro del bot padre.

3. Nei campi Valori di input, immetti i valori o le variabili da passare al bot figlio:

Nota:  You can pass a Window type variable from a parent bot to a child bot.

a) Select an input variable to activate the text field.
b) Enter a value of the required data type.

The icon on the left-side of the text field indicates the data type.

Se stai configurando un bot con molte variabili di input, utilizza l'opzione Mappa rapida per mappare
automaticamente le variabili che condividono lo stesso nome e tipo di dati. Se il bot figlio contiene
variabili per le quali non ci sono variabili corrispondenti nel bot padre, l'opzione Mappa rapida crea
nuove variabili e le mappa.

4. Opzionale: Select the repetition.
5. Opzionale: Seleziona l'opzione Ritardo tra ripetizioni e immetti il tempo di ritardo nei campi Minuti

e Secondi.
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6. Opzionale: Select the Upon error continue with next repetition or action in this bot option.
For alternative error-handling options, use actions from the Error handler package.
Error handler package alla pagina 1523

7. Nel campo Salva il risultato in una variabile, seleziona l'opzione Variabili multiple o
Dizionario:
Opzione Descrizione

Variabili multiple Fai clic su Aggiungi mappatura variabili
per associare ogni chiave del dizionario a una
variabile nel bot padre.
Usa questa opzione se non vuoi utilizzare actions
per estrarre i valori del dizionario.
Use the Multiple Variables option to assign
the output of the child bot to multiple variables
directly. Using this option, you can set the
multiple values returned by the child bot into
the dictionary variable of the parent bot. You no
longer need to assign the multiple outputs of the
child bot to the individual variables of the parent
bot using variable assignment commands. You
can use the Dictionary package in the parent bot
to extract the individual value assigned to the
dictionary variable of the parent bot.
For example, when you migrate Enterprise 11
bots, many output variables need to be assigned
individually after the Run task action, which
increases the size of the bot. You can directly set
parent bot variables within the Run task action
using the multiple variables option.

Dizionario inserisci o crea una variabile del dizionario per
contenere le variabili e i valori di output in coppie
chiave-valore.
Each key in the dictionary is the variable name
and corresponding value from the child bot.

8. Fai clic su Salva.

For an example of using this action:
• Example of using the Run action alla pagina 2074
• Example of sharing an Excel session between bots alla pagina 1899

Repeating a bot
Repeat a bot after run failure or when running routine bots.

Options for repeating a bot

Non ripetere Default. The bot runs once.
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Ripeti N volte Repeats the bot specified number of times.
Ripeti per unità di tempo Repeats the bot for a time period (hh:mm:ss).

Nota:  Specify up to 99 hours, 59 minutes, or 59
seconds.

Ripeti fino all’arresto da parte dell'utente Repeats the bot until being stopped manually by
clicking the stop button or by pressing the ESC
key.

Ritardo tra ripetizioni Sets a duration of time to wait before repeating a
bot (mm:ss).

Upon error continue with next repetition or
action in this bot

The bot is repeated regardless of run failure.

Nota:  Error handling cannot capture the error
when this option is enabled.

Stop action
The Stop action in the Task Bot package enables you to stop the running bot.

Impostazioni

Ad esempio, usa l'action Sospendi per terminare il bot se viene soddisfatta una condizione, come se il bot
rileva un file di dimensioni superiori a 100 MB.

Example of sharing an Excel session between bots
Build two bots to update the employee salaries in a worksheet. In this example, one bot opens an Excel
worksheet and passes the session name as a variable to the second bot, which iterates through the
worksheet, calculates each employee's new salary, and updates the value in the worksheet.
Create a worksheet with the following data:

Employee ID Data di inizio Salary

200 2020-01-12 50000

233 2018-03-15 75000

500 2020-06-06 60000

555 2019-07-09 65000

Build the child to iterate through the table of employees and update each salary to reflect the raise.
1. Apri un nuovo bot.

a) From Automation Anywhere web interface, on the left panel, click Automation.
Viene visualizzato un elenco di bot e moduli disponibili.

b) Fai clic su Crea un bot.
c) Enter the bot name RaiseSalaries.
d) Enter the folder location \Bots\TaskBotExample.

Per cambiare la posizione in cui viene memorizzato il bot, fai clic su Scegli e segui i prompt.
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e) Fai clic su Crea e Modifica.

2. Create the following variables:
• sessionVariable: session type; MS Excel subtype; use as input
• sCellAddress: string type; default value of C2
• sSalary: string type
• nSalary: number type

3. Use a Loop action to iterate through all the rows in the worksheet.
a) Fai doppio clic o trascina l'action Loop.
b) Select the For each row in worksheet iterator.
c) Select the Shared session tab and insert $sessionVariable$.
d) Select the Read cell value option.
e) In the Assign the current value to this variable field, create a record variable.

4. Retrieve the employee's salary.
a) Drag into the Loop container the Excel Advanced > Get single cell action.
b) Select the Shared session tab and insert $sessionVariable$.
c) Select the Specific cell option and insert $sCellAddress$.
d) Select the Read cell value option.
e) In the Store cell contents to field, insert $sSalary$.

5. Convert the salary value to a number data type.
a) Drag into the Loop container the String > To number action.
b) In the Enter the string field, insert $sSalary$.
c) In the Assign the output to variable field, insert $nSalary$.

6. Calculate the new salary to be five percent greater than the current salary.
a) Drag into the Loop container the Number > Assign action.
b) In the Select source variable field, enter $nSalary$*1.05.
c) In the Select destination variable field, insert $nSalary$.

7. Update the salary in the worksheet.
a) Drag into the Loop container the Excel Advanced > Set cell action.
b) Select the Shared session tab and insert $sessionVariable$.
c) Select the Specific cell option and insert $sCellAddress$.
d) In the Cell value field enter $nSalary.Number:toString$.

Nota:  You must convert the value to a string data type before the bot can enter it into the
worksheet. Use type casting as an alternative to the Number > To stringaction. Conversione del
tipo alla pagina 2034
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8. Move the cursor down by a single cell and assign that cell address to sCellAddress.
a) Drag into the Loop container the Excel Advanced > Go to cell action.
b) Select the Shared session tab and insert $sessionVariable$.
c) Select the Active cell and One cell below options.
d) Drag into the Loop container the Excel Advanced > Get cell address action.
e) Select the Shared session tab and insert $sessionVariable$.
f) Select the Active cell option.
g) In the Save active cell address field, insert $sCellAddress$.

9. Click Save and Close.
Crea il bot padre.
10. Apri un nuovo bot.

a) Fai clic su Crea un bot.
b) Enter the bot name ExcelParentBot.
c) Enter the folder location \Bots\TaskBotExample.

Per cambiare la posizione in cui viene memorizzato il bot, fai clic su Scegli e segui i prompt.
d) Fai clic su Crea e Modifica.

11. Create the following variable:
sessionVariable: session type; MS Excel subtype

12. Open the Excel worksheet.
a) Double-click or drag the Excel Advanced > Open action.
b) In the Session name field, enter Session1.
c) In the File path field, enter the file path to the worksheet you created above.
d) Select the Sheet contains header option.

13. Assign the session to a variable.
a) Double-click or drag the Excel Advanced > Set session variable action.
b) In the Session name field, enter Session1.
c) In the Save session to a variable field, select $sessionVariable$.

14. Select the child bot you built in the above.
a) Fai doppio clic o trascina l'action TaskBot > Esegui.
b) Click the Control Room file option and click Browse to select the RaiseSalaries bot.
c) In the Input values section, select the Set SessionVariable option and insert

$sessionVariable$.

15. Click Save and Run.
The Excel worksheet opens and the value of each cell in the third column increases by five percent.
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Terminal Emulator package
The Terminal Emulator package contains actions that enable you to connect to and automate tasks on
another machine. Use these actions to access and control operations on a remote machine. For example,
you can run applications and access files on a different operating system.
The Terminal Emulator enables a machine to connect to and communicate with another machine
using a command-line or graphical interface. The Terminal Emulator uses the Telnet or SSH protocol to
communicate with other machines.
The Terminal Emulator supports ANSI, TN3270E, TN5250E, and VT100 terminal types.

Important:  If you use different versions of the Terminal Emulator package in a parent bot and a child
bot, the capability to share a session across bots is currently not supported. To share a session across
parent and child bots, ensure that you use the same version of the package in both the parent and child
bots.

Prima di iniziare

Importante:  Before you establish a connection to a different terminal type, ensure that you have Visual
C++ 2019 Redistributable Package installed on your system. If you are on an Automation 360 version
earlier than A2019.14 (Build 5322), you must install Visual C++ 2013 Redistributable Package or Visual C+
+ 2015 Redistributable Package on your system.

Perform the following actions within the Terminal Emulator package as part of using the set of available
actions:
1. Establish a connection with a host machine using the Connect action.

You must first establish a connection with a host machine to automate any Terminal Emulator related
task. When establishing the connection, specify the details of the host machine and associate it with
a session name. Use the session name provided in this action in the other actions so that you do not
have to provide details of the host machine in those actions again. Consulta Using Connect action for
Terminal Emulator alla pagina 1903.

Importante:  If you use any other action from this package before establishing the connection, you
will encounter an error.

2. Use the Terminal Emulator actions to automate a task. For example, use the Get field action to
retrieve the value from a particular field.

3. After you have automated all the Terminal Emulator related tasks, terminate the connection to the
host machine using the Disconnect action.

Actions in the Terminal Emulator package

The Terminal Emulator package includes the following actions:

Action Descrizione

Cancella terminale Clear terminal action alla pagina 1903

Connetti Using Connect action for Terminal Emulator alla pagina 1903
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Action Descrizione

Disconnetti action Disconnetti alla pagina 1907

Ottieni tutti i campi Get all fields action alla pagina 1907

Ottieni campo Get field action alla pagina 1907

Ottieni testo Using Get text action for Terminal Emulator alla pagina 1908

Nascondi terminale Hide terminal action alla pagina 1908

Cerca campo Search field action alla pagina 1909

Invia chiave Using Send key action alla pagina 1909

Invia testo Using Send text action alla pagina 1911

Imposta posizione del
cursore

Set cursor position action alla pagina 1912

Imposta campo Using Set field action alla pagina 1912

Imposta variabile di
sessione

Set session variable action alla pagina 1913

Mostra terminale Show terminal action alla pagina 1913

Attendi Using Wait action alla pagina 1913

Clear terminal action
The Clear terminal action in the Terminal Emulator package enables you to clears the screen of the
terminal.

Impostazioni

Specify the Terminal emulator session name that you used to establish a connection with the terminal
using the Connect action.

Using Connect action for Terminal Emulator
Use the Connect action to establish a connection with a host machine on which you want to automate
a task. You can use this action to establish a connection with the TN3270E, TN5250E, ANSI, VT220, and
VT100 terminal types.
This action enables you to specify the details of the host machine and associate it with a session name.
Use the session name provided in this action in the other actions, so that you do not have to provide
details of the host machine in those actions again.

Importante:  If you use any other action from this package before establishing the connection, you will
encounter an error.

To establish a connection with a host machine, perform the following steps:
1. Double-click or drag the Connect action from the Terminal Emulator node in the Actions palette.
2. Specify a name for the session in the Terminal emulator session name field.
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Nota:  Use the different session name to open multiple terminal windows. If you want to use the
same session name, you must first close the session of the first terminal window before using the
same session name for another terminal window.

3. Specify the Host name of the machine you want to connect to:
a) Click the Credential tab to select an entry from the Credential Vault.
b) Click the Variable tab to use a variable to specify the host name.

4. Enter a value in the Port field to specify the port you want to use to connect to the host.
5. Select one of the following options to specify the terminal type:

Opzione Fasi

ANSI Select an option from the Connection type list to specify the type of
connection you want to establish:
• Telnet
• SSH2

For SSH2 connection type:
• For User authentication:

• User name: Click the Credential tab to select an entry from
the Credential Vault. You can also click the String tab to enter a
value manually.

• For Password: Click the Credential tab to select an entry from
the Credential Vault. You can also click the String tab to enter a
value manually.

• For Key file authentication: Click one of the following options to
specify the location of the file:
• File Control Room: Enables you to select a PDF file that is

available in a folder.
• Desktop profile: Enables you to select a PDF file that is

available on your device.
• Variabile: Enables you to specify the file variable that contains

the location of the PDF file.

• For User name: Click the Credential tab to select an entry from
the Credential Vault. You can also click the String tab to enter a
value manually.
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Opzione Fasi

TN3270E a. Select an option from the Host name security list to specify the
security you want to use:
• NONE
• SSL
• TLS

b. Select the Enable TN3270E support check box if you want to choose
a connection method.
Select an option from the Connection method list:
• GENERIC: Enables you to specify the Device name.
• SPECIFIC: Enables you to specify the Device name and

Resource (LU) Name.

c. Select an option from the Terminal model list to specify the terminal
workstation you want to connect to.

d. Select an option from the Code page list to specify the encoding you
want to use for the terminal.

TN5250E a. Select an option from the Host name security list to specify the
security you want to use:
• NONE
• SSL
• TLS

b. Select the Enable TN5250E support check box if you want to specify
details about the device and resource.
Enter a value in the Device name and Resource (LU) Name fields.

c. Select an option from the Terminal model list to specify the terminal
workstation you want to connect to.

d. Select an option from the Code page list to specify the encoding you
want to use for the terminal.
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Opzione Fasi

Serie VT
• VT100
• VT220

a. Select an option from the Terminal model list to specify the terminal
type you want to connect to.

b. Select an option from the Encoding list to specify the encoding you
want to use for the terminal:
• ANSI
• DBCS
• UTF-8

The CodePage field appears when DBCS option is selected. The
CodePage supports only Japanese Shift-JIS (932).

c. Select an option from the Connection type list to specify the type of
connection you want to establish:
• Telnet
• SSH2

For SSH2 connection type:
• For User authentication:

• User name: Click the Credential tab to select an entry
from the Credential Vault. You can also click the String tab
to enter a value manually.

• For Password: Click the Credential tab to select an entry
from the Credential Vault. You can also click the String tab
to enter a value manually.

• For Key file authentication: Click one of the following options
to specify the location of the file:
• File Control Room: Enables you to select a PDF file that is

available in a folder.
• Desktop profile: Enables you to select a PDF file that is

available on your device.
• Variabile: Enables you to specify the file variable that

contains the location of the PDF file.

• For User name: Click the Credential tab to select an entry
from the Credential Vault. You can also click the String tab to
enter a value manually.

6. Select the Show terminal window check box to show the terminal window when the bot runs this
action.

7. Select the Set cursor position to the beginning check box to edit the screen of the Terminal
emulator session manually and set the focus to the first editable field.

8. Select the Wait for the terminal prompt to appear while connected check box to wait for the
terminal prompt to appear on the screen of the terminal after the connection is established.
a) Enter the text you want to display when you connect to the terminal in the Terminal prompt

field.
b) Enter a value in the Wait time out field to specify the period in (milliseconds) the system must

wait before the connection request is timed out.
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9. Select any of the following tabs to create a terminal emulator session:
• Sessione locale: Specifica un nome sessione utilizzabile solo nel bot corrente.
• Sessione globale: Specifica un nome sessione utilizzabile in più bots come bots padre, bots figlio

e altri bots figli dei bots padre.
• Variabile: Specifica una variabile di sessione utilizzabile per condividere quella sessione con altri

bots figlio.

action Disconnetti
The Disconnect action in the Terminal Emulator package enables you to terminate the connection with the
terminal.

Impostazioni

Specify the Terminal emulator session name that you used to establish a connection with the terminal
using the Connect .

Get all fields action
The Get all fields action in the Terminal Emulator package enables you to retrieve the values of all fields
and assigns them to a table variable.

Impostazioni

• Specify the Terminal emulator session name that you used to establish a connection with the
terminal using the Connect .

• Select a table variable to store the retrieved data from the Assign the value to an existing table
variable list. The table stores each field as a row, with the values of each field organized in the
following columns:
• Indice campo
• Nome campo
• Valore del campo
• Is Editable (yes/no)
• Is Hidden (yes/no)

Nota:  You can use this action with the TN3270E and TN5250E terminal types.

Get field action
The Get field action in the Terminal Emulator package enables you to retrieve the value of a field based on
the index or name of the field and assigns it to a string variable.

Impostazioni

• Specify the Terminal emulator session name that you used to establish a connection with the
terminal using the Connect .

• Select the By index option to retrieve the value of a field based on its index, or select the By name
option to retrieve the value of a field based on its name.
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• Select a string variable to store the retrieved data from the Assign the value to an existing
variable list.

Nota:  You can use this action with the TN3270E and TN5250E terminal types.

Using Get text action for Terminal Emulator
Use the Get text action to retrieve text from the terminal and store it in a string variable. This action
enables you to retrieve text from the last line, all lines, or a range of lines. You can use this action with the
TN3270E, TN5250E, ANSI, and VT100 terminal types.
To retrieve text from the terminal, do the following:
1. Double-click or drag the Get text action from the Terminal Emulator node in the Actions palette.
2. Enter the name of the session that you have used to establish a connection with the terminal using

the Connect action in the Terminal emulator session name field.
3. Select an option from the Get text list to specify the lines from which you want to retrieve text:

• Last line: Retrieves text from the last line of the terminal.
• All lines: Retrieves text from all lines of the terminal.

Select from the following options to extract text from a specific area, viewable area, or the entire
page displayed on the screen.
• Viewport: Retrieves text from the visible area of the Terminal Emulator window.
• Number of lines from top: To retrieve text corresponding to a specific number of lines from

the top of the screen.
• Full page capture (with scroll): Retrieves all the lines on the screen, including the content

that needs to be scrolled to access it.

Nota:  The Full page capture (with scroll) and Number of lines from the top options are
supported only for ANSI and VT Series terminals. If you connect with other terminal types,
regardless of the option selected, the extracted text displays the results similar to how they are
displayed for the Viewport option.

• Lines from-to: Retrieves text from the specified range of lines of the terminal. You must enter
values in the Start row and End row fields to specify the range.

Nota:  You can specify a value of 1 through 999.

4. Select a string variable from the Assign the value to an existing variable list to assign the
retrieved text to that variable.

5. In the Assign value to variable list, select a string variable.

Hide terminal action
The Hide terminal action in the Terminal Emulator package enables you to hide the terminal screen.

Impostazioni

This action enables you to hide the terminal screen when the Show terminal window option from the
Connect action is selected. It is useful when you do not want to display the terminal screen when a bot
is performing certain tasks. Specify the Terminal emulator session name that you used to establish a
connection with the terminal using the Connect .
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Search field action
The search field action in the Terminal Emulator package enables you to search for the field based on the
text it contains.

Impostazioni

• From the Terminal emulator session name field, choose one of the following options:
• Local name to establish a connection with the terminal using the Connect action
• Shared session to share the variable from Set session variable or from the parent bot

• Specify the text based on which you want to search the field.
• Select an option from Select field to specify whether to retrieve the index or name of the field.
• Assign and save the output to a variable.

Nota:  The search text you enter must be a complete match and is not case-sensitive.

Using Send key action
Use the Send key action to send a key to the terminal. You can use these keys to perform various
operations on the terminal. You can use this action with the TN3270E, TN5250E, ANSI, and VT100 terminal
types.
To send a key to the terminal, do the following:
1. Double-click or drag the Send key action from the Terminal Emulator node in the Actions palette.
2. Enter the name of the session that you have used to establish a connection with the terminal using

the Connect action in the Terminal emulator session name field.
3. Select an option from the Select key to be send list to specify the key you want to send.
4. Enter a value in the Delay after send key command field to specify the period the system must

wait (in milliseconds) after the selected key is sent.
5. Select the Wait for text or prompt to appear check box if you want the system to wait for the

prompt or certain text to appear on the terminal.
a) Select the Prompt option if you want the system to wait till the prompt appears on the terminal.
b) Select the Text option if you want the system to wait till the specific text appears on the terminal.

You must provide the text you want to appear on the terminal in the Text value to be appear
on screen field.

c) Select the Wait before send key for prompt or text appear check box if you want the
system to wait for the prompt or the specified text to appear on the terminal before sending the
selected key.

d) Select the Wait after send key for prompt or text appear check box if you want the system
to wait for the prompt or the specified text to appear on the terminal after sending the selected
key.

e) Enter a value in the Time out for prompt or text to appear field to specify the period (in
seconds) the system must wait before the operation times out.

6. In the Assign value to variable list, select a string variable.

How send key works in Send text action
Learn how keys work in the Send Text action in the Terminal Emulator.
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Nota:  Behavior of the keys that are marked with the asterisk (*) sign in the following tables is defined by
the terminal host. The behavior might vary on different terminals.

The following table shows the behavior of the keys in the terminal types TN3270 and TN5250:

Keys Behavior

KEY_BACKSPACE Same behavior as the Backspace key on the keyboard.

KEY_BACKTAB If the cursor is on the first position of a field, it moves to the
previous field. Otherwise, it moves to the start of the current
field.

KEY_CLEAR Clears the entire text on the terminal screen.

KEY_ERASEINPUT Deletes all the text in the field.

KEY_NEXTFIELD Moves the cursor to the next field on the terminal screen.

KEY_ENTER Sends Enter key to the terminal host.

KEY_HOME Moves the cursor to the first editable field on the screen.

KEY_RESET The reset key only clears the Keyboard lock, such as releasing the
terminal if the terminal screen is not working. The screen text and
input field values remain the same.

KEY_LEFT Moves the cursor to the left by one position.

KEY_RIGHT Moves the cursor to the right by one position.

KEY_UP Moves the cursor up by one position.

KEY_DOWN Moves the cursor down by one position.

KEY_PGLEFT Nothing happens.

KEY_PGRIGHT Nothing happens.

KEY_PGUP Page Up key

KEY_PGDOWN Page Down key

KEY_TABFORWARD Performs a tab key action on the terminal screen to move the
cursor to the next field.

KEY_PF1 * Same behavior as F1 key on the keyboard.

KEY_PF2 * Same behavior as F2 key on the keyboard.

KEY_PF3 * Same behavior as F3 key on the keyboard.

KEY_PF4 * Same behavior as F4 key on the keyboard.

KEY_PF5 * Same behavior as F5 key on the keyboard.

KEY_PF6 * Same behavior as F6 key on the keyboard.

KEY_PF7 * Same behavior as F7 key on the keyboard.

KEY_PF8 * Same behavior as F8 key on the keyboard.

KEY_PF9 * Same behavior as F9 key on the keyboard.

KEY_PF10 * Same behavior as F10 key on the keyboard.

KEY_PF11 * Same behavior as F11 key on the keyboard.
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Keys Behavior

KEY_PF12 * Same behavior as F12 key on the keyboard

KEY_PF13 * Same behavior as Shift + F1 keys on the keyboard.

KEY_PF14 * Same behavior as Shift + F2 keys on the keyboard.

KEY_PF15 * Same behavior as Shift + F3 keys on the keyboard.

KEY_PF16 * Same behavior as Shift + F4 keys on the keyboard.

KEY_PF17 * Same behavior as Shift + F5 keys on the keyboard.

KEY_PF18 * Same behavior as Shift + F6 keys on the keyboard.

KEY_PF19 * Same behavior as Shift + F7 keys on the keyboard.

KEY_PF20 * Same behavior as Shift + F8 keys on the keyboard.

KEY_PF21 * Same behavior as Shift + F9 keys on the keyboard.

KEY_PF22 * Same behavior as Shift + F10 keys on the keyboard.

KEY_PF23 * Same behavior as Shift + F11 keys on the keyboard.

KEY_PF24 * Same behavior as Shift + F12 keys on the keyboard.

Using Send text action
Use the Send text action to send text to the terminal. This action also enables you to send predefined
keys after the text to perform various operations in the terminal. You can use this action with the
TN3270E, TN5250E, ANSI, and VT100 terminal types.
You can use the following keyboard shortcuts to send a key on the terminal window using Simulate
keystroke action:

Nota:  The keyboard shortcuts are supported in TN3270 and TN5250.

Key entry Comando

Shift + Control + A Seleziona tutto

Shift + Control + C Copy

Shift + Control + X Taglia

Shift + Control + V Incolla

To send a text to the terminal, follow these steps.
1. Double-click or drag the Send text action from the Terminal Emulator node in the Actions palette.
2. Enter the name of the session that you have used to establish a connection with the terminal using

the Connect action in the Terminal emulator session name field.
3. Specify the Text you want to send to the terminal:

a) Click the Credential tab to select an entry from the Credential Vault.
b) Click the Variable tab to use a variable that contains the text you want to send.

4. Select the Send a key after sending the above text check box if you want to send a key after
sending the text.
a) Select the key you want to send from the list.
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b) Enter a value in the Delay after send key command field to specify the period (in milliseconds)
the system must wait after sending the selected key.

5. Select the Wait for text or prompt to appear check box if you want the system to wait for the
prompt or certain text to appear on the terminal.
a) Select the Prompt option if you want the system to wait till the prompt appears on the terminal.
b) Select the Text option if you want the system to wait till the specific text appears on the terminal.

You must provide the text you want to appear on the terminal in the Text value to be appear
on screen field.

c) Select the Wait before send key for prompt or text appear check box if you want the
system to wait for the prompt or the specified text to appear on the terminal before sending the
selected key.

d) Select the Wait after send key for prompt or text appear check box if you want the system
to wait for the prompt or the specified text to appear on the terminal after sending the selected
key.

e) Enter a value in the Time out for prompt or text to appear field to specify the period (in
seconds) the system must wait before the operation times out.

6. In the Assign value to variable list, select a string variable.

Set cursor position action
The Set cursor position field action in the Terminal Emulator package enables you to set the position of the
cursor on the screen of the terminal.

Impostazioni

• Specify the Terminal emulator session name that you used to establish a connection with the
terminal using the Connect .

• Specify the row number in which to set the cursor in the Set row field.
• Specify the column number in which to set the cursor in the Set column field.

Nota:  You can enter a value of 1 through 999 to specify the row and column number where the cursor is
set.

Using Set field action
Use the Set field action to set a value in a particular field in the terminal. This action also enables you to
send predefined keys after the value to perform various operations in the terminal. You can use this action
with the TN3270E, TN5250E, ANSI, and VT100 terminal types.
To set a value for a field in the terminal, do the following:
1. Double-click or drag the Set field action from the Terminal Emulator node in the Actions palette.
2. Enter the name of the session that you have used to establish a connection with the terminal using

the Connect action in the Terminal emulator session name field.
3. Specify the field for which you want to set a value:

a) Select the By index option to specify the field based on its index.
The index value starts from zero and ends at 99999. For example, if you want to set the value for
the third field, you must specify 2 in this field.
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b) Select the By name option to specify the location of the field.
For example, if you want to set the value for a field in the fifth column of the third row, you must
specify R3C5 in the field.

4. Specify the Plain text value you want to set in the specified field:
a) Click the Credential tab to select an entry from the Credential Vault.
b) Click the Variable tab to use a variable that contains the text you want to send.

5. Select the Send enter key after setting field check box if you want to send the enter key after
setting the field.
This option performs the operation similar to pressing the Enter key after setting the value in the field.

6. Select the Send a key after sending the above text check box if you want to send a key after
sending the text.
a) Select the key you want to send from the list.
b) Enter a value in the Delay after send key command field to specify the period (in milliseconds)

the system must wait after sending the selected key.

7. In the Assign value to variable list, select a string variable.

Set session variable action
The Set session variable action in the Terminal Emulator package enables you to assign the session name
to a variable.

Impostazioni

Pass this session variable from the parent bot to a child bot by entering the variable as an input type
variable in the child bot.

Show terminal action
The Show terminal action in the Terminal Emulator package enables you to show the terminal screen.

Impostazioni

This action enables you to show the terminal screen when the Show terminal window option from the
Connect action is not selected. It is useful when you want to display the terminal screen when a bot is
performing certain tasks. You must specify Specify the Terminal emulator session name that you used
to establish a connection with the terminal using the Connect .

Using Wait action
Use the Wait action to introduce a delay till specific conditions are met in the terminal. You can use this
action to wait before executing the next action till the specific text appears on the screen, the cursor
moves to the specified location, and so on. You can use this action with the TN3270E, TN5250E, ANSI, and
VT100 terminal types.
To wait till specific conditions are met in the terminal, do the following:
1. Double-click or drag the Wait action from the Terminal Emulator node in the Actions palette.
2. Enter the name of the session that you have used to establish a connection with the terminal using

the Connect action in the Terminal emulator session name field.
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3. Select an option from the Terminal event list to specify a condition the system should wait till it is
met.
The following table provides information about the options available in the list and the input required
for each option:
Opzione Input required

Attendi fino alla comparsa del testo Waits until the text you specified in the Text field
matches with the last line of the screen in the
terminal.

Attendi fino alla scomparsa del testo Waits until the text you specified in the Text field
does not match or disappears on the last line of
the screen in the terminal.

Attendi fino allo spostamento del cursore in
posizione

Waits till the cursor moves to the position you
have specified in the Move to row and Move to
column fields.

Nota:  You can enter a value of 1 through 999
to specify the row and column number where the
cursor is set.

Attendi fino allo spostamento del cursore
fuori dalla posizione

Waits till the cursor moves out of the position
you have specified in the Move out of row and
Move out of column fields.

Nota:  You can enter a value of 1 through 999
to specify the row and column number where the
cursor is set.

Attendi fino a quando lo schermo non si
oscura

No input required.

Attenti fino a quando lo schermo non
contiene testo

Waits till the text you have specified in the Text
field is available on the screen of the terminal.

Attendi fino a quando non appare il prompt
del terminale

No input required.

Attendi fino a quando lo stato del terminale
nono è pronto

No input required.

4. Enter a value in the How long you would like to wait? field to specify the period (in milliseconds)
the system must wait before the operation times out.

5. In the Assign value to variable list, select a string variable.

Share session between TaskBot logic
Use the Shared Session option in the Terminal Emulator package to pass the exact state of an
application to the concurrently occurring TaskBot logic.
Shared session enables you to reuse actions between TaskBots that run concurrently, for example,
connecting to the same application.
To use shared session, create a hierarchy of TaskBot logic that are connected by the Shared Session
option. As a result, large TaskBot logic are trimmed by removing repetitive commands for connecting and
disconnecting.
1. Create a parent bot such as TE_Share_Main that connects to an application on the Terminal Emulator.
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2. Use the Set session variable action in the TE_Share_Main to assign the current session to a variable
such as $te_session$ of Terminal Emulator session type.

3. Create a child bot such as TE_BMIS to perform any actions such as Get text and Set field.
4. Add a Run Task action in the TE_Share_Main to call the TE_BMIS.
5. To pass a session variable from the TE_Share_Main to TE_BMIS , select $te_session$ as an input

value in the Set SessionVariable.
6. In the TE_BMIS , use Shared session tab and insert $te_session$ as a session variable to obtain

data or perform task.
7. In the main task, add an action to disconnect from the application.

Text file package
Open a text file, read data from that file, and save the data to a string variable by using the Text file
package. This package supports text files encoded in Shift-JIS, ANSI, UTF-16LE, UTF-16BE, Win 1521,
Unicode, and UTF-8 and can extract content up to 64kb from text files.

Actions nel package Text file

Il package Text file include le seguenti actions:

Action Descrizione

Ottieni testo Vedi Using Get text action of Text file package alla
pagina 1915

Read variables Vedi Read variables action alla pagina 1916

Using Get text action of Text file package
Extract content from a text file and save that content to a string variable by using the Get text action.
To extract text from a text file, perform the following steps:
1. In the Actions palette, double-click or drag the Get text action from the Text file package.
2. In the Source file field, select an option to specify the location of the text file:

• Control Room file to open a file from the Control Room.
• Desktop file to open a file from the device. This field also accepts the file path input as a string

variable or global value.
• Variable to open a file by specifying a file variable.
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3. In the Text encoding field, select an encoding to specify the encoding that is applied on the text file.
Data from the text file will be retrieved based on the selected encoding option even if the input file
has a different encoding.
• ANSI
• UTF8
• UTF8 con BOM
• UNICODE
• Win1251
• UTF-16LE
• UTF-16BE
• Shift-JIS
• Detect automatically: identifies file encoding. This option supports UTF-8 with BOM, ANSI,

UTF-16LE, and UTF-16BE file encoding.

4. Select the Trim leading spaces and Trim trailing spaces check boxes to remove the leading and
trailing spaces from the data extracted from the text file.

5. In Save the outcome to variable field, select a string variable to hold the output.

Read variables action
You can use the Read variables action in the Text file package to read the values of variables from the
text file.

Impostazioni

• In the Source file field, select an option to specify the location of the text file:
• File Control Room: Opens a file from the Control Room.
• File desktop: Opens a file from the device. This field also accepts the file path input as a string

variable or global value.
• Variabile: Opens a file by specifying a file variable.

• In the Text encoding field, specify the encoding to apply on the text file. Data from the text file is
retrieved based on the selected encoding option even if the input file has a different encoding.
• ANSI
• UTF-8
• UTF-8 con BOM
• Unicode
• Windows 1251
• UTF-16LE
• UTF-16BE
• Shift-JIS
• Detect automatically: Identifies the file encoding. This option supports UTF-8 with BOM, ANSI,

UTF-16LE, and UTF-16BE file encoding.

• Select the Trim leading spaces and Trim trailing spaces check boxes to remove the leading and
trailing spaces from the data extracted from the text file.

• Select the Convert dictionary keys to lower case before assignment to variables to convert all
the keys to lower case.

Nota:  When you select this option, ensure that you enter the key in lower case in the Mapped
variables table.
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• From the Save the outcome to variable field, select one of the following options to contain the
output:
• Variabili multiple: Click Add variable mapping to associate each dictionary key with a variable.

Use this option to avoid using actions to extract the dictionary values.
• Dizionario: Insert or create a dictionary variable to contain the output variables and values in key-

value pairs.

Trigger loop package
The Trigger loop package enables you to run a series of actions when a trigger event occurs. You can
insert multiple trigger loops within a bot or nest one trigger loop within another trigger loop.

Actions in the Trigger loop package

Azione Descrizione

Trigger loop Opens the loop to run a series of actions when a trigger event occurs.

Nota:  Events within the Trigger loop follow a sequential order and any
parallel events that occur during this time are queued.

Handle Specifies the trigger event and runs the actions that are inside the
container when that event occurs.
Drag the Handle action into the Trigger loop (in Flow view) or below
the Trigger loop (in List view).

Break Terminates the trigger loop for bot to continue with other actions in the
trigger event. If there is no Break action after a trigger loop handle,
the bot will go back to the start of the trigger loop and wait for the next
configured action. So ensure you add the Break action to exit the trigger
loop and move on to next action or else the bot will run indefinitely. For
example, the Break action in a bot can be used when the user must close
or cancel a form.
Drag the Break action into the trigger handle container.

Triggers in the Handle action

Trigger Descrizione Opzioni

Hot key Trigger Runs the actions when specific keys are
pressed.

• Modifiers: Ctrl, Shift, Alt, AltGr, and
Win

• Keys:
• Letters A-Z
• Numbers 0-9
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Trigger Descrizione Opzioni

Form Trigger Runs the actions when a form field is
modified. Select an existing form and
element.
Using interactive forms alla pagina 2186

• On click: Button is clicked.
• Got focus: Input field is clicked.
• Lost focus: User leaves the input

field.
• Changed value: Check box or

radio button status is changed.
• Value selected: Check box is

selected.
• Value unselected: Check box is

deselected.
• Assigned to (optional): Creates

or selects a variable, and assigns
the value from the specified form
element to this variable.

Object Trigger Runs the actions when an event occurs
on the selected interface element. For
example, when a user clicks a button.
Interface triggers for objects are
available only for native Windows
applications.

Attività correlate
Add a form to bot alla pagina 2205
Adding an existing form to a bot enables users to collaborate with bots. Use the necessary action items to
create a bot and build a task logic.

V11 Task Bot package
The V11 Task Bot package enables you to run an Enterprise 11 bot from Automation 360 in the
Enterprise 11 Control Room.

Actions in the V11 Task Bot package

The package includes the following action:

Action Descrizione

Esegui Consulta Using Run action alla pagina 1918.

Using Run action
Use the Run action to run an Enterprise 11 bot from Automation 360 in the Enterprise 11 Control Room.
Ensure that the Enterprise 11 user credential that you want to use to run the Enterprise 11 bot includes
the following:
• Access to the Enterprise 11 Bot Runner device on which you want to run the Enterprise 11 bots
• Run my bots and View my scheduled bots permissions
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To use the Send callback status to A2019 option, ensure the following:
• The IP address of the Automation 360 Bot Runner device on which you want to run the Automation 360

bot is a static IP address
• The IP address is available in the callback URL of the Enterprise 11 Control Room

Callback URLs for bot deployment

1. Double-click or drag the Run action from the V11 Task Bot node in the Actions palette.
2. Provide the Enterprise 11 Control Room URL in which you want to run the bot.
3. Click the Credential tab to use a value from the Credential Vault and the Variable to use a credential

variable.
Alternatively, click the Insecure string tab to manually specify the value you want to use as the
Username and Password to log in the Control Room you have specified.

4. Specify the location of the bot you want to run in the Task relative path field.
5. Opzionale: Specify the device on which you want to run the bot in the Bot Runner device name

field.
You can specify multiple devices separated by a semicolon. Ensure that the names of the devices you
have provided are the same as those on the My Devices page of the Enterprise 11 Control Room.
If you do not provide any value in the field, the system runs the bot on any connected devices (device
for which the user specified in the Step 3).

6. Select the Run bot runner session on Control Room check box to deploy the bot using the
remote desktop process.

7. Select the Wait for task to complete check box if you want the system to wait for the task to
complete before performing the next action in the bot.
a) Specify the period you want the system to wait before the bot is timed out in the Total wait

time field.
b) Select the version of the Control Room on which you want to run the bot.

• 11.3.2 or later (includes 11.3.3.x releases):
Click Advanced settings to expand and update the polling attributes.

Campo Descrizione

Wait time before start polling the status Period (in seconds) you want the system
to wait before it starts polling the status
after the bot is deployed on the device.

Polling interval for non-started execution Time interval at which you want
the system to poll for status for the
Enterprise 11 bot you have set to run but
has not started execution.

Polling interval for pending execution Time interval at which you want the
system to poll for status for the bot
that you have set to run and is pending
execution.

Polling interval for paused execution Time interval at which you want the
system to poll for status for the bot that
has started execution and is paused.
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Campo Descrizione

Polling interval for in-progress execution Time interval at which you want the
system to poll for status for the bot that
has started execution and is currently in
progress.

Polling interval for unknown execution Time interval at which you want the
system to poll for status for the bot that
has started execution and the current
status is unknown.

• 11.3.4 or later:
• Select the Send callback status to A2019 option to specify a range for the TCP port that you

want to use to send the callback status to Automation 360.

Campo Descrizione

Dalla porta TCP disponibile Starting value in the range for the
TCP port that you want to use to send
the callback status.

Alla porta TCP disponibile End value in the range for the TCP
port that you want to use to send the
callback status.

Nota:  The IP address of the Automation 360 Bot Runner must be reachable from Enterprise 11
Control Room on the range for the TCP port you have provided.

• Select the Poll status from 11.x Control Room option. Click Advanced settings to update
the polling status from the Enterprise 11 Control Room:

Campo Descrizione

Wait time before start polling the
status

Period (in seconds) you want the
system to wait before it starts polling
the status after the bot is deployed on
the device.

Polling interval for non-started
execution

Time interval at which you want
the system to poll for status for the
Enterprise 11 bot you have set to run
but has not started execution.

Polling interval for pending execution Time interval at which you want
the system to poll for status for the
bot that you have set to run and is
pending execution.

Polling interval for paused execution Time interval at which you want the
system to poll for status for the bot
that has started execution and is
paused.

Polling interval for in-progress
execution

Time interval at which you want the
system to poll for status for the bot
that has started execution and is
currently in progress.

© 2023 Automation Anywhere. All rights reserved.     1920



    Automation Anywhere - Crea

Campo Descrizione

Polling interval for unknown execution Time interval at which you want the
system to poll for status for the bot
that has started execution and the
current status is unknown.

8. Select the dictionary variable from the Input parameters list that you want to use to pass input
parameters for the bot.
The input variables that you want to pass for the bot are contained as keys in the dictionary variable
with their corresponding values.

9. Select the dictionary variable that you want to use to store the output from the Assign the output to
list.
The dictionary variable stores the output parameters of the Enterprise 11 bot as keys.
Additionally, the following keys are added in the dictionary variable by default:

Key Value

COMMAND Name of the command that was last
executed by the Enterprise 11 bot.

STATUS Status of the Enterprise 11 bot execution.

START_TIME Time when execution of the Enterprise 11
bot started.

END_TIME Time when execution of the Enterprise 11
bot ended.

AUTOMATION_NAME Name of the automation

10. Fai clic su Salva.

VBScript package
Il package VBScript contiene actions che abilitano le funzioni VBScript in un'attività.

Prima di iniziare

1. Verify that the device on which you want to run the VBScript has Windows operating system installed.
2. Open a VBScript file, or input the script you want to run using the Open action. You must associate

the details of the file or script you want to run with a session name. Utilizza questo stesso nome di
sessione per altre actions VBScript.

3. Use the Run function action to execute a function within the script or execute the entire script. You
must use the VBScript session name you established in the previous step.

4. After you have executed the script, close the VBScript session.
To review the bot launcher logs, navigate to C:\ProgramData\AutomationAnywhere
\BotRunner\Logs\<current month>\Bot_Launcher-<today's date>.log.zip. Each
zipped folder contains a file with data on the code execution, which is useful for debugging.
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Actions nel package VBScript

Il package VBScript include le seguenti actions:

Nota:  L'action Apri deve essere la prima action a utilizzare VBScript in un'attività.

Action Descrizione

Chiudi Consulta Close action in VBScript alla pagina 1922.

Esegui funzione Consulta Run function action in VBScript alla pagina 1922.

Apri Consulta Open action in VBScript alla pagina 1923.

Attività correlate
Example of using the VBScript package in a resilient bot alla pagina 2086
Build a bot that executes a Microsoft Visual Basic script. Use the Try/Catch package to gracefully end the
bot if it fails, making it resilient to crashes. A resilient bot allows scheduled and queued bots to continue
even if the current bot encounters an error.

Close action in VBScript
This action enables you to close the session in VBScript.

Impostazioni

Closes the session.
Specify the same session name from the Open action in VBScript.

Run function action in VBScript
You can run a function within VBScript using the Run function action.

Impostazioni

Runs a function within the VBScript.
• In the  VBScript  session field, specify a session name. Use the same session name from the Open

action in VBScript.
• Facoltativo: Specify the function name to run and the arguments to pass to the function.

Nota:  You can pass only a list variable as an argument for the function. You can use the list variable to
pass multiple arguments of different data types such as Boolean, datetime, number, and string.

• Facoltativo: If the specified function returns a value, specify the variable to store that value in the
Assign the output to variable field. La  mostra un nome descrittivo predefinito della variabile. If you
create several output variables, subsequent variable names are appended with a -1, -2, -3, and so on
to avoid duplication.

Nota:  In VBScript, stand alone scripts do not return a value.
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Open action in VBScript
This action enables you to open a VBScript file.

Impostazioni

Opens a VBScript file.
• In the  VBScript  session field, specify a session name. Use this same session name for other 

VBScript  actions.
• In the  VBScript , choose one of the following options:

• In the Import existing file option, select an existing VBScript file.

Nota:  If you are uploading a script from a file on your desktop, the file and any dependencies must
be in a standalone folder. When you select a file for upload, all files and folders at the same folder
level are uploaded.

• Nell'opzione Input manuale, immetti VBScript.

Wait package
Use the actions in the Wait package to add a condition to wait for an application screen to change, or a
separate window to open or close before proceeding to the next action.

Actions nel package Wait

Il package Wait include le seguenti actions:

Action Descrizione

Attendi la condizione Vedi Wait for condition action alla pagina 1923

Attenti che lo schermo
cambi

Consulta Using Wait for screen change action alla pagina 1924.

Attendi la finestra Consulta Using Wait for window action alla pagina 1927.

Wait for condition action
Makes the bot wait until a specific condition is true before executing the next action.

Impostazioni

In the Wait till field, specify the condition to meet. For example, the wait condition can be based on
whether an application is running, a folder or file exists, a variable matches the specified value, an
application window exists, or a machine or server is running.

Nota:
• If a bot encounters an internal error that does on appear on the UI, it does not wait for the amount of

time that is specified in this action. The bot does not stop and continues to the next line.
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• When you create a bot and use the variable option to search the window title and use the condition
Window exists, or Window does not exist the bot will not search for the changed window title.
Also, it will not identify the window title if you have changed the variable. You can use the condition
Window with same title does not exist, or Window with same title exist to verify whether a
window with the same title exists or changed.

This action offers the same conditions as the If package. See the If package alla pagina 1625.

Using Wait for screen change action
Use the Wait for screen change action to wait for the content of a specific screen or the entire window
to change before executing the next action.
For example, a Human Resources (HR) personnel automating leave-management tasks wants to log in to
the HR portal. After entering the user credentials, this action enables the automation task to wait until the
next screen loads.
1. In the Actions palette, double-click or drag the Wait for screen change action from the Wait

package.
2. In the Screen change relative to field, choose Window or Screen.
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3. Select an application window:
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Opzione Fasi

Applicazione From the drop-down list, select the window title
from the open applications.
• The Window title field displays the title of

the application window you have selected.
Inserisci un carattere jolly (*) nel campo
Titolo della finestra per cercare i titoli
delle finestre che possono cambiare. You can
specify one or more wildcards (*) at the start,
middle, or end of the value.For example, to
perform an operation on any window that
has Microsoft in the title, use a wildcard to
indicate any string by adding it before or after
the value: *Microsoft*. The  first searches
for the exact window title (Microsoft), and
if it does not find a match, it searches for
windows with the term Microsoft anywhere
in the title.
Puoi utilizzare un'espressione regolare (regex)
per identificare il titolo della finestra. Select
the regular expression condition as either
String or a Pattern and then enter the
value. By default, the Window title field is
case-sensitive.
To identify a browser title, you can enable
the Case sensitive option to match the
letter case, or disable the option to identify a
window title where the letter case does not
match.

Nota:  Ensure that the minimum  version
installed on your system is the version that
was released with  v.26. If you have a  version
released with  v.25 or earlier, then by default,
the window title will be identified only with
matching letter case (case-sensitive).

For example, you can enter the String
value as ((\w*)-Notepad for all window
title names starting with ((\w*)-
Notepad, or use Pattern value as
((\w)\s)*document-Notepad for only
those window titles that match this pattern.

Nota:
• When you use a regular expression of

type String with -title as the input
value for a window title in any , the  might
encounter a run time error. To prevent
the run time error, ensure that when you
add the string input as *-title, the
application with the specific title is open.
The asterisk (*) is just a character, not a
wild card character.

• When you use a regular expression of
type Pattern with -title as the input
value for a window title in any , the  might
encounter a run time error because the
input value *-title is incorrect.
Ensure that you use valid regex patterns.

• The Executable field displays the complete
path of the executable file to identify the right
window.
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Opzione Fasi

Browser Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based ,
and  browsers.

Variabile Use a window variable to specify the application
window you want to use.

4. Opzionale: Seleziona l'opzione Ridimensiona finestra per specificare le dimensioni della finestra.
This option delivers a more reliable bot. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the botto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Nota:  This option is available only for windows that can be resized. Non è disponibile per le opzioni
Desktop o Barra dei comandi.

5. Click Capture region.
The selected window appears.

6. Drag the mouse to draw a rectangle around the region that you want to capture and right-click when
done.
The captured area appears in the Preview section, followed by the image coordinates X, Y, Width,
and Height.

7. In the How long to wait before comparing screens? field, specify the wait time (in seconds) to
begin comparing the window or screen.
When a difference is detected, the comparison stops and the task proceeds to the next action.

8. In the How long to wait before screen comparing is stopped? field, specify the wait time (in
seconds) for the screen to change.
If the screen does not change within the time you specified, the task proceeds with the next action.

9. Select the Throw an exception if the screen is not changed option to show an error message
and terminate the bot if the screen does not change.
If the option is deselected and the screen does not change, the task proceeds with the next action.

10. Fai clic su Salva.

Using Wait for window action
Use the Wait for window action to wait for the specified window to open or close before executing the
next action.
For example, a Human Resources (HR) personnel automating leave-management tasks might require the
attendance application to open before they enter the user credentials. This action enables the automation
task to wait until the application window opens.
1. In the Actions palette, double-click or drag the Wait for window action from the Wait package.
2. In the Wait for window field, select the option you want the automation to wait for:

• Wait for window to open
• Wait for window to close

3. Select an application window:
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Opzione Fasi

Applicazione From the drop-down list, select the window title
from the open applications.
• The Window title field displays the title of

the application window you have selected.
Inserisci un carattere jolly (*) nel campo
Titolo della finestra per cercare i titoli
delle finestre che possono cambiare. You can
specify one or more wildcards (*) at the start,
middle, or end of the value.For example, to
perform an operation on any window that
has Microsoft in the title, use a wildcard to
indicate any string by adding it before or after
the value: *Microsoft*. The  first searches
for the exact window title (Microsoft), and
if it does not find a match, it searches for
windows with the term Microsoft anywhere
in the title.
Puoi utilizzare un'espressione regolare (regex)
per identificare il titolo della finestra. Select
the regular expression condition as either
String or a Pattern and then enter the
value. By default, the Window title field is
case-sensitive.
To identify a browser title, you can enable
the Case sensitive option to match the
letter case, or disable the option to identify a
window title where the letter case does not
match.

Nota:  Ensure that the minimum  version
installed on your system is the version that
was released with  v.26. If you have a  version
released with  v.25 or earlier, then by default,
the window title will be identified only with
matching letter case (case-sensitive).

For example, you can enter the String
value as ((\w*)-Notepad for all window
title names starting with ((\w*)-
Notepad, or use Pattern value as
((\w)\s)*document-Notepad for only
those window titles that match this pattern.

Nota:
• When you use a regular expression of

type String with -title as the input
value for a window title in any , the  might
encounter a run time error. To prevent
the run time error, ensure that when you
add the string input as *-title, the
application with the specific title is open.
The asterisk (*) is just a character, not a
wild card character.

• When you use a regular expression of
type Pattern with -title as the input
value for a window title in any , the  might
encounter a run time error because the
input value *-title is incorrect.
Ensure that you use valid regex patterns.

• The Executable field displays the complete
path of the executable file to identify the right
window.
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Opzione Fasi

Browser Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based ,
and  browsers.

Variabile Use a window variable to specify the application
window you want to use.

4. In the How long you would like to wait for this condition to be true? field, specify the wait
time (in seconds) for the window to open or close.
If the window does not open or close within the time you specify, the task proceeds to execute the
next set of actions.

5. Select the Throw an exception if wait for window is unsuccessful option to show an error
message and terminate the bot if the window does not open or close within the specified amount of
time.
If the option is deselected and the window does not open or close within the specified amount of time,
the task proceeds with the next action.

6. Fai clic su Salva.

Window package
Use the Window package to automate tasks relating to the window.
Window is a data type available for storing application window titles. It is the only data type that can
be used in all the actions of the Window package. Create a variable of data type Window and select or
assign a window title.

Nota:  Quando si crea una variabile di tipo Finestra, si noti che la selezione Browser come valore
predefinito supporta solo le schede di Google Chrome, mentre selezionando Applicazione come valore
predefinito si supporta qualsiasi finestra di applicazione.

Use this variable in any number of actions within the automation task. If the application window title
changes, then change the value assigned to the variable. The new application title is reflected in all the
actions where the variable is used.

Actions nel package Window

Il package Window include le seguenti actions:

Action Descrizione

Attiva… Vedi Activate action in Window alla pagina 1930

Assegna Vedi Assign action in Window alla pagina 1931

Chiudi Vedi Close action in Window alla pagina 1931

Chiudi tutto Vedi Close all action in Window alla pagina 1932

Ottieni titolo finestra
attiva

Vedi Get active window title action in Window alla pagina 1933

Ingrandisci Vedi Maximize action in Window alla pagina 1933

Riduci a icona Vedi Minimize action in Window alla pagina 1934
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Action Descrizione

Ridimensiona Vedi Resize action in Window alla pagina 1935

Ripristina Vedi Restore action in Window alla pagina 1936

Imposta titolo Vedi Set title action in Window alla pagina 1936

Activate action in Window
The Activate action in the Window package enables you to activate a window.

Impostazioni

• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.
• Applicazione: seleziona da un elenco di finestre, incluse le finestre del browser, attualmente aperte

sul dispositivo Bot Creator.
• Browser: Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based , and  browsers.

• Variabile: seleziona una variabile finestra esistente per specificare il titolo del titolo della finestra
dell'applicazione.

• In the Window title field, specify the title.
Inserisci un carattere jolly (*) nel campo Titolo della finestra per cercare i titoli delle finestre che
possono cambiare. You can specify one or more wildcards (*) at the start, middle, or end of the value.
For example, to perform an operation on any window that has Microsoft in the title, use a wildcard
to indicate any string by adding it before or after the value: *Microsoft*. The  first searches for the
exact window title (Microsoft), and if it does not find a match, it searches for windows with the term
Microsoft anywhere in the title.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
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you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

Assign action in Window
The Assign action in the Window package enables you to assign a source window variable's value to a
designated window.

Impostazioni

• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.
• Applicazione: seleziona da un elenco di finestre, incluse le finestre del browser, attualmente aperte

sul dispositivo .
• Browser: Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based , and  browsers.

• Variabile: seleziona una variabile finestra esistente per specificare il titolo del titolo della finestra
dell'applicazione.

• In the Select the destination window variable/value field, specify the variable.

Nota:  The regular expression (regex) is currently not supported.

Close action in Window
The Close action in the Window package enables you to close the application window.

Impostazioni

• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.
• Applicazione: seleziona da un elenco di finestre, incluse le finestre del browser, attualmente aperte

sul dispositivo .
• Browser: Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based , and  browsers.

• Variabile: seleziona una variabile finestra esistente per specificare il titolo del titolo della finestra
dell'applicazione.

Inserisci un carattere jolly (*) nel campo Titolo della finestra per cercare i titoli delle finestre che
possono cambiare. You can specify one or more wildcards (*) at the start, middle, or end of the value.
For example, to perform an operation on any window that has Microsoft in the title, use a wildcard
to indicate any string by adding it before or after the value: *Microsoft*. The  first searches for the
exact window title (Microsoft), and if it does not find a match, it searches for windows with the term
Microsoft anywhere in the title.
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Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or disable
the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released with 
v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be identified
only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those window
titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window title

in any , the  might encounter a run time error. To prevent the run time error, ensure that when you add
the string input as *-title, the application with the specific title is open. The asterisk (*) is just a
character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window title
in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

Nota:
• When multiple Excel windows are opened, the bot closes all the open Microsoft Excel windows even

when a specific Excel window name is selected to close.
• When you select Currently active as the window title, to close any active windows, and then run the

bot, the Shut Down Windows pop-up is no longer activated, even if there are no active windows on
the machine.

Close all action in Window
The Close all action in the Window package enables you to close all the windows.

Impostazioni

In the Add window field, you can provide the title of the application windows that you do not want to
close.
You can also search the window titles by using (*) as a wildcard character. Specify one or more (*)
wildcards at the start, middle, or end of the title. For example, to perform an operation on any window that
has Microsoft in the title, use a wildcard to indicate any string by adding it before or after the value:
*Microsoft*. The bot first searches for the exact window title (Microsoft), and if it does not find a
match, it searches for windows with the term Microsoft anywhere in the title.

Nota:  To keep the Bot editor window open, ensure that you add it in the Add window field. For
example, enter *Control Room | Automation Anywhere* in the window title to keep it open.
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Get active window title action in Window
The Get active window title action in the Window package enables you to retrieve the title of the active
window.

Impostazioni

In the Assign the window title to variable field, specify the variable.
La  mostra un nome descrittivo predefinito della variabile. If you create several output variables,
subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.

Nota:  The regular expression (regex) is currently not supported.

Maximize action in Window
The Maximize action in the Window package enables you to maximize a window.

Impostazioni

• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.
• Applicazione: seleziona da un elenco di finestre, incluse le finestre del browser, attualmente aperte

sul dispositivo .
• Browser: Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based , and  browsers.

• Variabile: seleziona una variabile finestra esistente per specificare il titolo del titolo della finestra
dell'applicazione.

Inserisci un carattere jolly (*) nel campo Titolo della finestra per cercare i titoli delle finestre che
possono cambiare. You can specify one or more wildcards (*) at the start, middle, or end of the value.
For example, to perform an operation on any window that has Microsoft in the title, use a wildcard
to indicate any string by adding it before or after the value: *Microsoft*. The  first searches for the
exact window title (Microsoft), and if it does not find a match, it searches for windows with the term
Microsoft anywhere in the title.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or disable
the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released with 
v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be identified
only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those window
titles that match this pattern.

Nota:
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• When you use a regular expression of type String with -title as the input value for a window title
in any , the  might encounter a run time error. To prevent the run time error, ensure that when you add
the string input as *-title, the application with the specific title is open. The asterisk (*) is just a
character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window title
in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

Minimize action in Window
The Minimize action in the Window package enables you to minimize a window.

Impostazioni

• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.
• Applicazione: seleziona da un elenco di finestre, incluse le finestre del browser, attualmente aperte

sul dispositivo .
• Browser: Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based , and  browsers.

• Variabile: seleziona una variabile finestra esistente per specificare il titolo del titolo della finestra
dell'applicazione.

Inserisci un carattere jolly (*) nel campo Titolo della finestra per cercare i titoli delle finestre che
possono cambiare. You can specify one or more wildcards (*) at the start, middle, or end of the value.
For example, to perform an operation on any window that has Microsoft in the title, use a wildcard
to indicate any string by adding it before or after the value: *Microsoft*. The  first searches for the
exact window title (Microsoft), and if it does not find a match, it searches for windows with the term
Microsoft anywhere in the title.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or disable
the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released with 
v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be identified
only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those window
titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window title

in any , the  might encounter a run time error. To prevent the run time error, ensure that when you add
the string input as *-title, the application with the specific title is open. The asterisk (*) is just a
character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window title
in any , the  might encounter a run time error because the input value *-title is incorrect.
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Ensure that you use valid regex patterns.

Resize action in Window
The Resize action in the Window package enables you to resize a window.

Impostazioni

• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.
• Applicazione: seleziona da un elenco di finestre, incluse le finestre del browser, attualmente aperte

sul dispositivo .
• Browser: Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based , and  browsers.

• Variabile: seleziona una variabile finestra esistente per specificare il titolo del titolo della finestra
dell'applicazione.

• Inserisci un carattere jolly (*) nel campo Titolo della finestra per cercare i titoli delle finestre che
possono cambiare. You can specify one or more wildcards (*) at the start, middle, or end of the value.
For example, to perform an operation on any window that has Microsoft in the title, use a wildcard
to indicate any string by adding it before or after the value: *Microsoft*. The  first searches for the
exact window title (Microsoft), and if it does not find a match, it searches for windows with the term
Microsoft anywhere in the title.

• Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

• In the Left, Top, Width, and Height fields, specify values for resizing the window.
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Restore action in Window
The Restore action in the Window package enables you to restore a window.

Impostazioni

• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.
• Applicazione: seleziona da un elenco di finestre, incluse le finestre del browser, attualmente aperte

sul dispositivo .
• Browser: Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based , and  browsers.

• Variabile: seleziona una variabile finestra esistente per specificare il titolo del titolo della finestra
dell'applicazione.

• Inserisci un carattere jolly (*) nel campo Titolo della finestra per cercare i titoli delle finestre che
possono cambiare. You can specify one or more wildcards (*) at the start, middle, or end of the value.
For example, to perform an operation on any window that has Microsoft in the title, use a wildcard
to indicate any string by adding it before or after the value: *Microsoft*. The  first searches for the
exact window title (Microsoft), and if it does not find a match, it searches for windows with the term
Microsoft anywhere in the title.

• Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

Set title action in Window
The Set title action in the Window package assign a new window title to a window variable.
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Impostazioni

• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.
• Applicazione: seleziona da un elenco di finestre, incluse le finestre del browser, attualmente aperte

sul dispositivo .
• Browser: Select from a list of supported browser tabs.

Nota:  This option supports , Chromium-based , and  browsers.

• Variabile: seleziona una variabile finestra esistente per specificare il titolo del titolo della finestra
dell'applicazione.

• In the New window title field, enter the new title.

Nota:  The regular expression (regex) is currently not supported.

Workload package
The Workload package enables you to insert work items in a queue for workload automation. It also
enables data chaining between multiple queues. You can orchestrate multiple bots, and enable optimal
device utilization through the queueing mechanism of workload management.

For example, a business process of Employee Salary Processing:
• A payroll queue can process the employee salaries, and a payroll bot can add work items to a finance

queue.
• The finance queue in turn can release the funds to employees and a finance bot in turn adds works

items in a HR queue to email employees on the salary processing completion.

You must have the Queue Owner or Participant privileges to view the list of queues in the Workload
package.

Actions nel package Workload

Il package Workload include le seguenti action:

Nota:  If you built a bot using actions from the Workload package from Build 5322 or earlier, the action
will be missing when you open the bot with the default package version. You must reinsert the action and
repopulate the fields.

Action Descrizione

Inserisci elemento di lavoro Allows you to insert a work item from an
existing queue to another queue as part of a bot
execution.

Concetti correlati
Gestione del carico di lavoro alla pagina 2797
Il modulo di gestione del carico di lavoro consente agli utenti di caricare file in formato Microsoft Excel e
CSV nella Control Room in modo che questa possa inserire i record dai file nelle distribuzioni dei bot.
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Attività correlate
Attach work item template to TaskBot alla pagina 2009
Attach a work item template to a TaskBot to use the TaskBot in workload automation.
Use Work Item variables alla pagina 2038
You can use the Work Item variables to pass the Work Item attributes or values to the TaskBot from the
Control Room when you run the bot with the option Run bot with queue.

Using Insert work item action
The Insert work item action provides you the flexibility to insert a work item to another queue as part of
a bot execution.
• You must have the Queue Owner or Participant privileges to view the list of queues in the Workload

package.
• Ensure that the bot is not connected to a Work item template.

Use the Insert work item to manage complex workflows by configuring a bot to add work items from
multiple queues. For example, use a bot to read a list of invoices from a .csv file and add the invoices due
for payment to another bot that manages information of payments due on specific dates. The automation
can be used in the scenarios where work items are part of a different system (Database, Excel) and the
bot reads them and adds them to a queue or where one queue adds work items to another queue as part
of data chaining.
1. In the Automation page, Create a bot or Edit an existing bot.
2. In the Actions palette, double-click or drag the Insert Work Item action from the Workload

package.
3. In the Workload: Insert work item window, add parameters such as the Queue and work item

values:
a) Click Browse to select a queue name from the list of queues to insert as a work item.
b) Click Confirm to add the queue.
c) Start entering work item values in the work item fields.

Nota:  These parameters are populated based on the work item template associated with the
selected queue.

You can also assign a variable value to these parameters by pressing the F2 key and selecting a
variable name from the list.

Suggerimento:  Use UTC format (YYYY-mm-dd 00:00:00) for Date data type.

4. Fai clic su Salva.
The action is added to the bot.

5. Add more data using the Insert Work Item action.
After the required data is added, Save the bot and Check in the bot to the Public folder for further
processing and deployment.

Concetti correlati
Creazione di code di carichi di lavoro alla pagina 2799
A queue is one of the main building blocks of Workload Management. A queue holds data known as
Work Items for further processing. The system distributes these Work Items to individual unattended Bot
Runners in a device pool for processing.
Attività correlate
Attach work item template to TaskBot alla pagina 2009
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Attach a work item template to a TaskBot to use the TaskBot in workload automation.
Use Work Item variables alla pagina 2038
You can use the Work Item variables to pass the Work Item attributes or values to the TaskBot from the
Control Room when you run the bot with the option Run bot with queue.
Insert Work Items alla pagina 2805
Add Work Items from an Excel or CSV file to the queue after you define the structure.

XML package
Extensible Markup Language (XML) is a markup language designed to store and transport data. Use the
actions in the XML package to automate the processing of XML data generated from web services and
cloud computing applications.
An XML document is structured as an ordered and labeled tree. Each node of the tree is an XML element
and is written with an opening and closing tag. In the following example, custname and custid are nodes:

<customer>
<custname>XYZ Corp</custname>
<custid>A001</custid>
</customer>

XPath is a query language that uses path expressions to select nodes or node-sets in an XML document.
XPath includes built-in functions for manipulation of string, numeric, Boolean, date and time, and so on.

Prima di iniziare

Perform the following actions within the XMLpackage.
1. Avvia la sessione XML utilizzando l'action Avvia sessione XML. Use this session name for all

corresponding actions.
2. Use the different actions available in the XML package to automate XML-related tasks.
3. Salva la sessione utilizzando l'action Salva sessione XML per assegnare i dati a un file o a una

variabile di tipo stringa.
4. Termina la sessione utilizzando l'action Termina sessione XML per completare un'attività.

Actions nel package XML

The XML includes the following actions:

Action Descrizione

Elimina nodo Consulta Delete node action in XML alla pagina 1940.

Termina sessione Consulta End session action in XML alla pagina 1940.

Esegui funzione XPath Consulta Execute XPath function action in XML alla pagina 1940.

Ottieni più nodi Consulta Get multiple nodes action in XML alla pagina 1940.

Ottieni nodo singolo Consulta Get single node action in XML alla pagina 1941.

Inserisci nodo Consulta Using Insert node action alla pagina 1942.

Salva i dati della
sessione

Consulta Save session data action in XML alla pagina 1942.
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Action Descrizione

Inizia sessione Consulta Start session action in XML alla pagina 1943.

Aggiorna nodo Consulta Update node action in XML alla pagina 1943.

Convalida documento
XML

Consulta Validate XML document action in XML alla pagina 1943.

Delete node action in XML
The Delete node action in the XML package enables you to delete a specific node from XML file.

Impostazioni

• Immetti il Nome della sessione o seleziona una variabile esistente utilizzata nell'action Avvia
sessione XML.

• Immetti l'Espressione XPath per il nodo da eliminare.
• Enter the attribute (optional).

End session action in XML
The End session action in the XML package enables you to close an XML session.

Impostazioni

Enter the session name or select an existing variable used in the Start XML session action .

Nota:  The End session action clears out session-related data from memory. To save the modified data,
use the Save session data action.

Execute XPath function action in XML
The Execute XPath function action in the XML package enables you to execute XPath function and store
the results in a variable.

Impostazioni

• Immetti il Nome della sessione o seleziona una variabile esistente utilizzata nell'action Avvia
sessione XML.

• Immetti l'Espressione XPath o seleziona una variabile esistente.
• Assegna una Variabile di tipo Stringa all'output.

Get multiple nodes action in XML
The Get multiple nodes action in the XML package enables you to retrieve the value of multiple nodes.

Impostazioni

• Immetti il Nome della sessione o seleziona una variabile esistente utilizzata nell'action Avvia
sessione XML.
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• Immetti l'Espressione XPath per recuperare più nodi o seleziona una variabile esistente.
• Nel campo Ottieni ogni nodo, seleziona se sono necessari i dati di Valore testo, Espressione XPath o

Nome specifico attributo di ciascun nodo.
Ad esempio,

<Customer>
<Cust_Details>
 <custid>A001</ custid>
<custname>XYZ Corp</custname>
<custzipcode>15639</custzipcode>
<country>Mexico</country>
<Locale lang=”es”> Spanish</Locale>
</Cust_Details>
</Customer>

• Il valore del testo recupera il valore esatto dell'elemento del nodo specifico. For example, the
custname element of a Cust_Details node retrieves the names of all the customers of the
company.

• Espressione XPath si riferisce al percorso del nodo selezionato in un documento XML. An XPath
expression such as Customer//Cust_Details//custid selects only customer IDs that are
available in the customer details node.

• L'attributo specifico definisce una proprietà o il tipo di elemento in un nodo specifico. For example,
lang is an attribute of the Locale element in a Cust_Details node. The output for lang
attribute is displayed as es.

Get single node action in XML
The Get single node action in the XML package enables you to retrieve the value of a single node.

Impostazioni

• Immetti il Nome della sessione o seleziona una variabile esistente utilizzata nell'action Avvia
sessione XML.

• Immetti l'Espressione XPath e l'Attributo (facoltativo) per recuperare un nodo.
Ottieni nodo singolo recupera il primo valore dal documento XML in base all'espressione XPath e
all'attributo forniti. Ad esempio,

<Customer>
<Cust_Details>
 <custid>A001</ custid>
<custname>XYZ Corp</custname>
<custzipcode>15639</custzipcode>
<country>Mexico</country>
<Locale lang=”es”> Spanish</Locale>
</Cust_Details>
</Customer>

• Espressione XPath con attributo: Viene visualizzato il valore dell'attributo dell'elemento espressione
XPath. For example, if the XPath expression is entered as Customer//Cust_Details//Locale
with the attribute as lang, the output is displayed as es.

• Espressione XPath senza attributo: Viene visualizzato il valore dell'elemento espressione XPath. For
example, if the XPath expression is entered as Customer//Cust_Details//Locale without any
attribute, Spanish is displayed as an output.
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• Assegna l'output a una Variabile di tipo Stringa.

Using Insert node action
Use this action to insert a node in an existing XML file and assign it to a value. Optionally, assign a name
space and attributes to the node.
To insert a node, do the following:
1. Enter the session name.

Use the name of the session that you have used in the Start XML session action.
2. Specify an XPath expression to indicate where to insert the new node.
3. Enter a node name.
4. Enter a value for the node.
5. If the node name exists, select from the following options:

• Insert it anyways
• Skip it
• Overwrite it

6. Specify the location to insert the node from the following options:
• Beginning of the child nodes
• End of the child nodes
• Before specific child note
• After specific child node

If Before Specific child node or After Specific child node is selected, specify the child node
name before or after which the node must be inserted.

7. Opzionale: Enter the default name space to be mapped to the node.
8. Enter the attributes using a Dictionary-type variable.

Create a new variable of type Dictionary or use one that already exists.
9. Opzionale: Enter the attribute name space using a Dictionary-type variable

Create a new Dictionary-type variable or use one that already exists.
10. Fai clic su Salva.

Save session data action in XML
The Save session data action in the XML package enables you to save the XML session data to a file or
variable of type String.

Impostazioni

• Immetti il Nome della sessione o seleziona una variabile esistente utilizzata nell'action Avvia
sessione XML.

• To save the session data to a file, select the Write XML data option and specify a file path.
• Seleziona Sovrascrivi per sostituire il file esistente, se un file con lo stesso nome è già presente nella

posizione specificata.
• Assegna l'output a una Variabile di tipo Stringa.

Nota:  The session data will be saved if you select the Write XML data option.
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Start session action in XML
The Start session action in the XML package enables you to create a new XML session based on an XML
file or specified text.

Impostazioni

• Start the XML session.
• Immetti il Nome della sessione o seleziona una variabile esistente utilizzata nell'action Avvia

sessione XML. Utilizza questo Nome della sessione per tutti le actions corrispondenti.
• Nel campo Origine dati, seleziona File o Testo:

• File: Da File Control Room, seleziona File sul desktop o una Variabile esistente di tipo File.
• Testo: specifica il nome del testo o seleziona una variabile esistente.

• Save the XML session.

Update node action in XML
The Update node action in the XML package enables you to update the value of a node.

Impostazioni

• Digita il Nome della sessione o seleziona una variabile esistente utilizzata nell'action Avvia sessione
XML.

• Immetti l'Espressione XPath per il nodo da aggiornare.
• Immetti un Nuovo valore per il nodo.
• Select the Updates attribute (s) option to create a new Dictionary or to add an existing Variable

of Dictionary-type.

Validate XML document action in XML
The tags and document structure are defined when the XML document is created. Use the Validate XML
document action in the XML package to validate an XML document.

Impostazioni

• Immetti il Nome della sessione o seleziona una variabile esistente utilizzata nell'action Avvia
sessione XML.

• Select the validation type from the following options:
• File schema XML (.xsd)

• Elenco: Specify the schema XSD file path you want to validate in the Value field. Click Add to
add multiple XML schema files (.xsd).

• Variables: Create a new variable of type List with subtype String and enter the XSD file path in
the Default value field (optional) or use an existing variable.

• Definizioni tipo di documento interno (DTD)
• Ben formato

• Assegna l'output a una variabile utilizzando Assegna l'output (Valido o Non valido) alla variabile
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Example for using actions in XML package
Using the XML package, create a bot that reads and writes data from an XML file to an Excel sheet.
The sample XML used in this tutorial has the following structure:

<movies>
    <movie genre="" year="">
        <name></name>
        <description></description>
        <director></director>
        <writers>
            <writer type=""></writer>
            <writer type=""></writer>
        </writers>
        <rating>R</rating>
    </movie>
</movies>

Before you begin, download a sample XML file.

The tutorial is intended to demonstrate the following actions:
• Use an XPath expression to get a node set with specific value and iterate through the items in the node

set, for example, movies with specific rating in this tutorial.
• Use an XPath function to iterate through the child node sets.
• Concatenate variables to build a string.
• Write data to an Excel sheet.

Ensure the following:
• You know how to create bots.
• You are familiar with the Control Room user interface.

1. Create a bot and name it XMLDataReader.

2. Add a step to group all tasks for opening an Excel sheet.
a) Add the Step > Step action after the Start flow in the Bot editor.

Nota:  To add an action, search for the action in the Actions pane and drag it to the bot flow in
the Bot editor.

b) In Title, enter Open an Excel Sheet and save the action.

3. To create and open an Excel sheet, use Excel advanced > Create workbook.
a) Add the Excel advanced > Create workbook action within the Step action.
b) In File path, enter C:\movies\movies.xlsx, and save the action. If the movies folder does

not exist in the specified path, create a movies folder in the path.
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4. To select the first cell on the Excel sheet, use the Excel advanced > Go to cell action.
a) Add the Excel advanced > Go to cell action after the Excel advanced: Create workbook

action.
b) Click Specific cell if it is not already selected, and enter A1.
c) Save the action.

5. Create another step to group all the tasks for retrieving XML data.
a) Add the Step > Step action after the first Step action.
b) In Title, enter Get XML Data and save the action.

6. Start an XML session.
a) Add the XML > Start session action within the Get XML Data step.
b) Under File, select Desktop, browse and select the sample XML file that you downloaded.
c) Salva le modifiche.

7. To get all movie nodes with rating R, use the Get multiple nodes action.
a) Add the XML > Get multiple nodes action after the Start session action.
b) In XPath Expression, enter //movie[rating/text()='R'], and save the action.

The selected node set is stored in a system variable and is available to the For each Node in a
XML dataset iterator now.

c) To ensure that the action retrieves the entire node set instead of just the text nodes, click Xpath
expression.

8. Use the Loop action to iterate through the selected node set that the Get multiple nodes action
retrieves.
a) Add Loop > Loop after the XML: Get multiple nodes action.
b) Under Iterator, select XML > For each Node in a XML dataset as the iterator.
c) In Assign the current row to this variable, click (x) and create a variable with the default

name, for example, XMLNode. Each item in the node set is now available through the variable.
d) Salva il action.

9. To get the movie name from the iterated node, use the Get single node action.
a) Add the XML > Get single node action within the Loop: Loop action.
b) In XPath expression, enter $XMLNode$/name.
c) In Assign the output to variable, create a variable and name it sMovieName.
d) Salva il action.

10. To write the movie name from the XMLNode variable, use the Set cell action.
a) Add the Excel advanced > Set cell action after the Get single node action.
b) Click Active cell, enter $sMovieName$ in Cell value, and save the action.
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11. To select a new cell within the Excel sheet, use the Go to cell action.
a) Add the Go to cell action after the Set cell action after the Excel advanced: Set cell action.
b) Click Active cell, select One cell to the right, and then save the action.

12. To get the director name from the iterated node, use the Get single node action.
a) Add the XML > Get single node action after the Excel advanced: Go to cell action.
b) In XPath expression, enter $XMLNode$/director.
c) In Assign the output to variable, create a variable with the following name: sDirector
d) Salva il action.

13. To write the director name from the XMLNode variable, use the Set cell action.
a) Add the Excel advanced > Set cell action after the XML: Get single node action.
b) Click Active cell, enter $sDirector$ in Cell value, and save the action.

14. To select a new cell within the Excel sheet, use the Go to cell action.
a) Add the Go to cell action after the Excel advanced: Set cell action.
b) Click Active cell, select One cell to the right, and then save the action.

15. Because the<writers>node can contain multiple<writer>nodes, get each writer name,
concatenate the names, and write them to a single cell instead of writing values to multiple cells. To
do so, add the Loop action within the current Loop action.
a) To get the number of the<writer>nodes within the<writers>node, add the XML > Execute

XPath function after the Excel advanced: Set cell action. In XPath expression, enter
count($XMLNode$/writers/writer). In Assign the output to variable, create a variable
named sWriterCount.
You will use the<writer>node count to loop through all the<writer>nodes.

b) Add the Loop > Loop action after the XML: Execute XPath function action.

Importante:  The second Loop action must be added within the main Loop action.

c) Under Iterator, select For n times as the iterator.
d) In Times, enter the following: $sWriterCount.String:toNumber$

Nota:  sWriterCount contains a string value. To convert string to number, you can use the
$<variable name>.String:toNumber$ format, for example, $sWriterCount.String:toNumber$.

e) In Assign the current value to variable (optional), create a variable named Counter.
f) Salva il action.
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16. To concatenate the values from all writer nodes, create a string variable.
a) In the Variables pane, click the plus icon.

The Create variable window opens.
b) In Type, select String.
c) In Name, enter sWriters.
d) Fai clic su Crea.

17. To get the value from the iterated<writer>node, use the Get single node action.
a) Add the XML > Get single node action within the second Loop action.
b) In XPath expression, enter $XMLNode$/writers/writer[$Counter.Number:toString

$].
Using the Counter variable, you can access a node at a specific index. Note that because the
Counter variable contains a numeric value, the .Number:toString$ expression is added to the
Counter variable to convert it to a string.

c) In Assign the output to variable, create a variable and name it sWriter.
d) Salva il action.

18. To assign values from the writer nodes, use the String > Assign action.
a) Add String > Assign action after the XML: Get single node within the second loop.
b) In Select the source string variable(s)/ value (optional), enter $sWriters$, $sWriter

$.
c) In Select the destination string variable, select sWriters.
d) Salva il action.

After the inner loop is complete, the sWriters variable will contain all the writer names.

19. To write the writer names to a new cell, use the Excel advanced > Set cell action within the main
loop.
a) Add the Excel advanced > Set cell action after the inner Loop action within the first Loop

action.
b) Click Active cell.
c) Enter $sWriters$ in Cell value.
d) Salva il action.

The data retrieved from one<movie>node is written to a row. To write the data from the
next<movie>node, you must select the next row in the Excel sheet.

20. To move the cursor to the next row, use the Excel advanced > Go to cell action.
a) Add the Go to cell action after the Set cell action.
b) Click Active cell, select Beginning of the row, and then save the action.
c) Add the Go to cell action again. Click Active cell, select One cell below, and then save the

action.
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21. Before the next node in the retrieved<movie>node set is iterated, you must reset the sWriters
variable. To reset the sWriters variable, perform the following steps:
a) Add the String > Assign action after the Excel advanced: Go to cell within the main loop.
b) Leave Select the source string variable(s)/ value (optional) blank.
c) In Select the destination string variable, select sWriters.
d) Salva il action.

22. Create a new step.
a) Add the Step > Step action after the second Step action.
b) In Title, enter Close the file.

23. To close the Excel sheet, use Excel advanced Close action.
a) Add Excel advanced > Close within the Close the file step.
b) Salva le modifiche.

24. Run the bot.

Get started with recorders
You can use two recorders in Automation 360, the Universal Recorder and the AISense Recorder, to
automate tasks by recording interactions with objects such as click, read (data extraction), and write (data
entry).

An integrated Recorder

In versions 2.0.9-20201105-164103 and later, the Recorder package contains both the Universal Recorder
and AISense Recorder. This offers the following benefits:
• Feature updates are delivered as delta updates, which reduces the time spent downloading the newest

Recorder package each release.
• The Start recording icon serves as a common entry point to both recorders.

Nota:  The AISense Recorder fails if you manually upgrade the Recorder package version, such as by
importing a bot that contains the integrated Recorder package (Version A2019.17 and later) to a Control
Room that has a build from Version A2019.16 or earlier. Always upgrade the Recorder package through the
Control Room. Do not attempt to manually upgrade by importing a .jar file or bot.

Choosing which recorder to use for your task

Before you start building your bot, decide which recorder best fits your requirements.

Universal Recorder Usa Universal Recorder quando vuoi registrare
interazioni come click, lettura o scrittura con oggetti
dell'interfaccia utente nell'applicazione aziendale.
Dopo aver acquisito l'oggetto, puoi specificare
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i requisiti in termini di action da eseguire su
quell'oggetto.
Ad esempio, se acquisisci un collegamento
ipertestuale, puoi selezionare un'azione per fare
clic sul collegamento o recuperarne il testo. Allo
stesso modo, se acquisisci un oggetto tabella, puoi
specificare se recuperare il numero totale di righe
da un oggetto tabella o recuperare ogni riga una
per una ed eseguire qualsiasi actions su di essa.
Questa è la forma più affidabile di automazione
perché viene eseguita su oggetti dell'interfaccia
utente piuttosto che su coordinate, immagini,
pressione di tasti e così via.

AISense Recorder Usa AISense Recorder quando stai costruendo e
automatizzando i bots su applicazioni che sono
esposte su Citrix o a cui si accede tramite RDP. Puoi
anche ridurre il tempo impiegato per costruire e
automatizzare i bots per le applicazioni legacy in cui
l'automazione basata sugli oggetti è complessa.
La resilienza del registratore alla risoluzione dello
schermo, ai browser e alle alterazioni dell'interfaccia
utente riduce le limitazioni e gli ostacoli quando si
registrano attività nelle applicazioni aziendali.

Universal Recorder for object-based automation
Utilizza il Universal Recorder per registrare le interazioni, ad esempio fare clic, leggere (estrazione dati) e
scrivere (immissione dati) con oggetti interfaccia utente (UI) sul desktop, nella barra delle applicazioni o in
un'applicazione o in una finestra del browser.
I precedenti prodotti RPA Automation Anywhere come Version 11.3 hanno tre registratori separati per
acquisire oggetti da vari ambienti. Automation 360 combina le capacità di questi tre registratori nel
Universal Recorder per semplificare il processo di registrazione.

Using the Universal Recorder

You can use the Universal Recorder in the following ways:
1. To record a process consisting of multiple steps, use the Universal Recorder video camera icon, which

is located on the top-left of the workbench.
A seconda di dove si desidera aggiungere le nuove actions acquisite in un TaskBot esistente, utilizzare
uno dei seguenti modi:
• Per aggiungere actions appena acquisite sotto un'action esistente, seleziona l'action esistente e

avvia la registrazione.
• Per aggiungere actions appena acquisite prima di actions esistenti disponibili all'interno di un'altra

action, seleziona l'altra action e avvia la registrazione. Ad esempio, se vuoi aggiungere le actions
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appena acquisite prima delle actions esistenti disponibili all'interno di un'action loop, seleziona
l'action loop e avvia la registrazione.

Nota:  Se non si seleziona alcuna action, allora le actions appena acquisite verranno aggiunte, per
impostazione predefinita, alla fine del TaskBot.

Consulta Record a task with the Universal Recorder alla pagina 1951.
2. To record a single interaction that you want to add into an existing TaskBot (for example, if you

missed a step when recording a task), use Capture action from the Recorder package.
Consulta Utilizzo dell'action Acquisisci alla pagina 1763.
For a common use case, see Example of entering data into a web form from a worksheet alla pagina 2054.

Il Universal Recorder viene anche utilizzato nelle actions per acquisire coordinate (action Mouse > Fai
clic) o un percorso file locale (action Applicazione > Apri programma/file).

Elaborazione in background

L'elaborazione in background permette di eseguire in background un'automazione che comporta
l'interazione con un'applicazione in primo piano (come i clic del mouse). Si consiglia di utilizzare l'opzione
per l'esecuzione in background per aumentare la visibilità dell'oggetto di destinazione e migliorare la
precisione del bot. The following actions support background processing:
• Fai clic
• Imposta testo
• Ottieni testo

Attività correlate
Record a task with the Universal Recorder alla pagina 1951
Use the Universal Recorder to capture a series of interactions (clicks, keystrokes, and mouse movements)
with object controls including text boxes, buttons, tables, menus, radio buttons, combo boxes, check
boxes, list views, links, trees, and page tabs.
Edit a task recorded with the Universal Recorder alla pagina 1952
After recording a task, edit the Capture actions to change the window, capture a different object, select a
new action, enable background processing, enter a different wait time, or save the output to a variable.
Riferimenti correlati
Requisiti del browser per RPA Workspace alla pagina 866
Accedi all'interfaccia RPA Workspace da un browser. After you have installed and enabled extensions in
the browser, perform several tasks through the RPA Workspace interface based on your user role and
automation requirements.
Secure recording mode alla pagina 1964
Quando la modalità di registrazione sicura è abilitata, i bots non acquisiscono i valori di alcune proprietà
né memorizzano immagini dell'applicazione. This ensures that sensitive data is not stored in the bots. This
setting only applies to bots that are created or edited after the mode is enabled.
Recording tasks in applications that run on JRE alla pagina 1965
Use the Universal Recorder to capture objects from Java applet, web start, and desktop applications that
run using Java Runtime Environment (JRE) 6, 7, 8, 9, 10, and 11.
Pacchetto Recorder alla pagina 1751
Il package Registratore acquisisce una serie di compiti in un processo e poi li automatizza. Puoi
automatizzare le applicazioni aziendali (per esempio, applicazioni desktop, web, SAP e Java) usando
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Recorder per acquisire le actions eseguite su oggetti dell'applicazione come una casella di testo, un
pulsante, una tabella, un pulsante di opzione, una casella combinata e una vista elenco.
Actions performed on objects captured with Universal Recorder alla pagina 1755
After capturing the object, specify the action for the bot to do to the object at runtime. Ad esempio,
se acquisisci un collegamento ipertestuale, puoi selezionare un'azione per fare clic sul collegamento o
recuperarne il testo. Refer to the table below for the objects and their possible actions.

Record a task with the Universal Recorder
Use the Universal Recorder to capture a series of interactions (clicks, keystrokes, and mouse movements)
with object controls including text boxes, buttons, tables, menus, radio buttons, combo boxes, check
boxes, list views, links, trees, and page tabs.
• To use the Recorder, you must already have done the following:

• Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039
• Set user device credentials alla pagina 1052

• Configure device display and font scale to 100%.
Se utilizzi la versione 2.0.6-20200626-193519 o successiva del package Recorder, puoi registrare le
attività nelle applicazioni di automazione Google Chrome, Internet Explorer, Java, Microsoft Active
Accessibility e Microsoft UI su un computer con scala di visualizzazione configurata al 100%, 125% o
150%.

• If you are automating a task using a browser, configure the zoom level to 100%.
If you are using Recorder package version 2.0.6-20200626-193519 or later, you can record tasks in a
Google Chrome browser that does not have a zoom level setting of 100%.

• If you are automating a task using a Google Chrome browser, ensure that the Automation Anywhere
plug-in that corresponds with the Automation 360 build version is enabled.
Requisiti del browser per RPA Workspace alla pagina 866

• To automate web applications running on Microsoft Edge Chromium browser in Internet Explorer mode
using the Universal Recorder, ensure that the Internet Explorer compatibility mode is enabled. The
objects on the web applications are captured using HTML technology. To enable this mode, perform the
following steps:
1. On the Microsoft Edge Chromium browser page, click Settings.
2. On the left panel, click Default browser.
3. Navigate to the Allow sites to be reloaded in Internet Explorer mode option and select

Allow.
4. Click Add to add the URL of the page that you want to load in Internet Explorer mode.

Nota:  The pages that you add open in Internet Explorer mode for 30 days from the date when
you add the page.

Considerations when recording a task:
• Use clicks when possible rather than shortcut keys.

Quando fai clic su un oggetto utilizzando Recorder, questo recupera le proprietà dell'oggetto che
consentono al bot di identificare l'oggetto in fase di runtime. Le scorciatoie da tastiera sono meno
affidabili, quindi usale quando non è possibile automatizzare l'attività con un clic su un oggetto.

• If you are automating a task using a browser, do not use autofill to enter values into fields.
• Record the task at low speed.
• Avoid dragging windows during the recording process.
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• Avoid clicking on applications that are not part of the process you are recording and automating.
• When Internet Explorer is used, the action waits until the browser is completely rendered and is in a

ready state before executing the action.

To record a task using the Universal Recorder, follow these steps:
1. From Automation Anywhere web interface left panel, click Automation.
2. Create a new bot or open an existing bot for which you want to record a task.
3. Click Start recording.

Nota:  In versions 2.0.9-20201105-164103 and later, the Recorder package contains both the
Universal Recorder and AISense Recorder.
An integrated Recorder alla pagina 1948

The Automation Anywhere Recorder window appears.
4. Select a window from the drop-down list.

If you opened an application recently and it is not available in the list, click the Refresh icon.
5. Click Universal Recorder.
6. Perform the steps in the task. For example, click buttons, fill in forms, or search a website.

To perform an action on an object, move the mouse pointer on that object. The object is highlighted
with a box. If the box does not appear, verify that you have enabled the necessary plug-in. For more
information, see Universal Recorder supported applications and browsers alla pagina 1958.
The Recorder window contains the number of operations recorded and a description of the most
recently captured object. For example, 5. Left click on button 'Submit'.
To redo the previous object capture, click the Delete icon at the bottom right of the Recorder
window to discard the most recent capture.
If Secure recording mode is enabled, a shield icon appears to the right of the red recording icon.
Secure recording mode alla pagina 1964

7. Click Finish after you finish capturing all the necessary objects.
A Capture action is generated for each operation.
Where applicable, the Recorder generates variables. Le tue variabili (definite dall'utente) alla pagina
2026

8. Edit the actions or click Save.
Edit a task recorded with the Universal Recorder alla pagina 1952

Edit a task recorded with the Universal Recorder
After recording a task, edit the Capture actions to change the window, capture a different object, select a
new action, enable background processing, enter a different wait time, or save the output to a variable.
Select the List view to see the full details of each action.
Edit a recorded task to do the following:
• Change the application window in which you want to perform the operation, or add a wildcard to the

window title.
• Change the properties of the captured objects.
• Specify the action you want to perform on the captured objects.
• Introduce a delay before the next action is performed.
• Specify the variable you want to use to store the output.
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To add a Capture action to the task, see Utilizzo dell'action Acquisisci alla pagina 1763.
To edit a recorded task, perform the following steps:
1. Open the bot that contains the recorded actions you want to edit.
2. Click the Capture action that you want to edit.
Make the following changes, as necessary:
3. Change the window selection to the Currently active window option.
4. Opzionale: Inserisci un carattere jolly (*) nel campo Titolo della finestra per cercare i titoli delle

finestre che possono cambiare. You can specify one or more wildcards (*) at the start, middle, or end
of the value.
For example, to perform an operation on any window that has Microsoft in the title, use a wildcard
to indicate any string by adding it before or after the value: *Microsoft*. The  first searches for
the exact window title (Microsoft), and if it does not find a match, it searches for windows with the
term Microsoft anywhere in the title.
Puoi utilizzare un'espressione regolare (regex) per identificare il titolo della finestra. Select the regular
expression condition as either String or a Pattern and then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Nota:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Nota:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
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you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

Nota:  During runtime, verify that the TaskBot identifies the correct window. If it does not, do the
following:
a. Open the application or browser window.
b. Trascina l'action Finestra > Ottieni titolo della finestra attiva sull'action Registratore >

Acquisisci.
c. Inserisci una variabile stringa nel campo Assegna il titolo della finestra a una variabile.
d. Trascina l'action Finestra > Imposta titolo sotto l'action Finestra > Ottieni titolo della

finestra attiva.
e. Nel campo Finestra, inserisci la variabile della finestra generata dall'action Registratore >

Acquisisci.
f. Nel campo Nuovo titolo della finestra, inserisci la variabile stringa dall'action Ottieni titolo

della finestra attiva.
g. Fai clic su Salva.

5. Opzionale: Seleziona l'opzione Ridimensiona finestra per specificare le dimensioni della finestra.
This option delivers a more reliable bot. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the botto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Nota:  This option is available only for windows that can be resized. Non è disponibile per le opzioni
Desktop o Barra dei comandi.

6. Esamina la tabella Proprietà oggetto.
Following are the list of object properties that are selected by default based on the technology type:

Important:  The following list does not include all the properties and is restricted to the most
commonly used and important properties based on the technology type

Technology type Proprietà oggetto Descrizione

Tecnologia HTML Tipo di controllo This is a read-only property that shows the type
of object captured, for example, text box or
button.
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Technology type Proprietà oggetto Descrizione

DOMXPath È il percorso che viene utilizzato per localizzare
il controllo o l'oggetto acquisito. DOMXPath
può essere di due tipi: XPath relativo e XPath
assoluto.
• Xpath assoluto: Contiene il percorso

completo dall'elemento radice all'elemento
desiderato. For example, an absolute Xpath
for this topic would be /html/body/div/
div[1]/main/div[2]/div/div/div[2]/
div/div/div[1]/div/article/main/
article/div/p[1]

• Xpath relativo: Questo è un percorso più
breve che si riferisce a un elemento che si
vuole identificare. A relative path starts with
a // symbol. For example, the relative XPath
for this topic would be //*[@id="cloud-
using-recorder-action"]/div/p[1]

Ad esempio, se vuoi trovare il DOMXPath di un
particolare elemento sul browser Google Chrome,
esegui questi passaggi:
a. Seleziona l'elemento per il quale vuoi estrarre

l'XPath.
b. Fai clic con il tasto destro del mouse

sull'elemento e seleziona Ispeziona.
c. Right-click the highlighted element in the

Element tab.
d. Go to Copy > Copy Xpath to copy the

relative path and select Copy > Copy full
Xpath to copy the absolute path.

Percorso It is a numeric representation of the position
of a particular control in an application. For
web applications, the best practise is to use
DOMXPath from the search criteria when
comapred to Path.

Nome e ID HTML These properties are used to identify an HTML
object

Testo interno
HTML

La proprietà DOM innerText è utilizzata per
impostare o restituire il contenuto testuale di un
nodo specificato e dei suoi discendenti

Tag HTML I tag HTML sono come parole chiave che
definiscono il modo in cui il browser web
formatta e visualizza il contenuto. Ad esempio,
se il testo catturato ha un codice HTML: <h3
 class="search_results-title">Search
 results for ״string package״</h3>,
then enter h3 in the HTML tag field.
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Technology type Proprietà oggetto Descrizione

Tipo di controllo Questa proprietà è utilizzata solo come
riferimento per assicurare che l'oggetto corretto
sia acquisito

Percorso È una rappresentazione numerica della posizione
di un particolare controllo in un'applicazione

Nome Specifica il nome di un elemento e funziona come
un identificatore

Microsoft Active
Accessibility

ID Specifica l'ID di un elemento e funziona come un
identificatore

Tipo di controllo Questa proprietà è utilizzata solo come
riferimento per assicurare che l'oggetto corretto
sia acquisito

Java Technology

Percorso È una rappresentazione numerica della posizione
di un particolare controllo in un'applicazione

Tipo di controllo Questa proprietà è utilizzata solo come
riferimento per assicurare che l'oggetto corretto
sia acquisito

Percorso È una rappresentazione numerica della posizione
di un particolare controllo in un'applicazione

Nome Specifica il nome di un elemento e funziona come
un identificatore

Microsoft UI
Automation

ID Specifica l'ID di un elemento e funziona come un
identificatore

Tipo di controllo This property is used only as a reference to
ensure that the correct object is captured.

Percorso It is a numeric representation of the position of a
particular control in an application.

Nome This specifies a name of an element and works as
an identifier.

Microsoft UI
Automation (COM)

ID This specifies the ID of an element and works as
an identifier.

The bot uses the selected properties to identify the object control at runtime.
a) Verifica che il Tipo di controllo corrisponda all'oggetto desiderato.

For example, when capturing a table from a website, ensure the Control Type and HTML Tag
values are Table.
Se il Tipo di controllo non corrisponde all'oggetto desiderato, riacquisisci il controllo dell'oggetto.

b) Select and assign values to the object properties that you want to include in the object search.
Per un bot più affidabile, si consiglia di selezionare solo le proprietà che hanno valori statici (come
Name, Classe, Tipo, ID HTML e DOMXPATH) e deselezionare le proprietà che hanno valori
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dinamici (come HTML Href, Percorso o Valore), che sono soggetti a cambiamenti e causano
errori nei bot.
It is a best practice to use the wildcard character (*) or variable in object property values to
search for objects whose properties are dynamic and changes frequently.

7. Seleziona Azione dall'elenco a discesa.
For a full list of possible actions by object, see Actions performed on objects captured with Universal
Recorder alla pagina 1755.
• If you record a click and keystrokes in a text box with a Control Type of Password text,

the Recorder does not capture the keystrokes entered into the field. Invece, l'action seleziona
l'opzione Imposta testo e offre opzioni per inserire la password in modo sicuro. We recommend
that you store the password in the Credential Vault and insert it into the action as a credential.
Credentials and credential variables in the Bot editor alla pagina 2039
If you navigate to the text box using the TAB keystroke instead of a click in an MSAA or SAP
application, the Recorder is able to identify fields with a Control Type of Password text.
We recommend that you use the Set text action without setting a delay time to enter keystrokes
into a text field. However, if the text that you want to enter consists of a control key value or a text
field requires any key press event, then you must set a delay time between the keystrokes when
using the Set text action.

• If the selected Action supports background processing, a Run in the background option
appears. Elaborazione in background alla pagina 1950

8. Opzionale: Immetti un valore nel campo Attendi il controllo per specificare il numero di secondi che
il bot deve attendere affinché il controllo dell'oggetto venga visualizzato nella finestra dell'applicazione.

9. Opzionale: Assign the output to a variable.
La Control Room suggerisce un nome di variabile predefinito descrittivo basato sull'azione selezionata
al passaggio 8. For example, if you selected Get property, the suggested output variable is
PropertyValue. If you create several output variables, subsequent variable names are appended
with a -1 to avoid duplication.

10. Perform the Steps 3 through 9 for the other actions that you want to edit in the bot.
11. Fai clic su Salva.

Link an object to a supporting anchor

Nota:  You can use object anchoring in Microsoft Active Accessibility, Microsoft UI Automation, or Java
applications.

At runtime, if the bot cannot reliably identify an object, link it to a nearby object (such as a link or button)
that is easier for the bot to find:
1. Open the Capture action.
2. Click the Anchor tab.
3. Click Capture anchor.

The browser or application window activates with the main object highlighted (the object that you
previously captured). A dialog box appears, verifying whether the action has correctly identified the
main object.

4. If the correct object is highlighted, click Yes, Select anchor.
Otherwise, click No, I need to correct it to select the correct object.

5. Select a nearby object to the target object that is easier for the bot to find.
The object is highlighted with an anchor icon on the right of the object.
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6. Click Save.

Universal Recorder supported applications and browsers
Use the Universal Recorder to record interactions with objects from the supported technologies.

Applicazioni • Applicazioni HTML
• Java applet, web start, and desktop applications

that run using Java Runtime Environment
(JRE) 6, 7, 8, 9, 10, and 11 (32-bit and 64-bit
versions)
Consulta Recording tasks in applications that run on
JRE alla pagina 1965.

• Microsoft Active Accessibility and UI automation
• Microsoft Silverlight version 5 (standard

Microsoft controls only)
• Oracle EBS and Forms
• SAP versions 730, 740, 750 patch 9, 760 patch

5, and 770 patch 6
• Citrix Virtual Apps
• Electron

Technologies • Microsoft Active Accessibility (MSAA)
• Microsoft UI automation

Nota:
Silverlight technology is supported for migrated
bots only. You can migrate any Enterprise 11 bots
that you created using Silverlight technology to
Automation 360. To modify the migrated bots
or create new bots to automate Silverlight web
applications, you can capture the web application
using Microsoft UI Automation technology. Microsoft
UI automation supports only standard controls for a
Silverlight application.

Browser • Google Chrome (versions 91 and later) for
Manifest V3 extension

• Google Chrome (versions 90 and earlier) for
Manifest V2 extension
Per costruire ed eseguire bots che contengono
actions dal package Recorder, è necessario
abilitare l'estensione Google Chrome che
corrisponde alla versione del package Recorder
. Vedi Google Chrome browser extension
requirements alla pagina 1959.
Se si verifica un errore durante la registrazione o
l'esecuzione di un bot che automatizza le attività
in un browser Google Chrome e hai installato
Google Chrome, devi eseguire ulteriori passaggi
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per configurare il sistema. See Google Chrome
extension troubleshooting alla pagina 1960.

• Internet Explorer (versione 11)
• Microsoft Edge (version 91 and later) for

Manifest V3 extension
• Microsoft Edge (version 90 and earlier) for

Manifest V2 extension
• Microsoft Edge basato su Chromium (versioni 79

e successive)
Microsoft Edge is supported on Recorder
package version 2.0.9-20201105-164103 and
later. You must install the A2019 plug-in for
Microsoft Edge and verify that it is running in
the Task Manager: Automation 360 extension for
Microsoft Edge

Nota:  Ensure that the Google Chrome
extension is not installed in the Microsoft Edge
browser because that configuration causes
recording and runtime errors. Google Chrome
extension installed in Microsoft Edge alla pagina
1963

• Mozilla Firefox (versioni 80 e successive)
Mozilla Firefox is supported on Recorder package
version 2.0.11-20210128-034104 and later. È
necessario installare l'estensione A2019 per
Mozilla Firefox: Automation 360 extension for
Mozilla Firefox

Desktop The desktop refers to the device screen when all
application and browser windows are minimized.

Barra dei comandi The taskbar is the horizontal or vertical bar
containing icons of open applications and browsers,
as well as the notification area. You can capture
application, browser, and system icons, such as
Clock and Calendar, volume, and Wi-Fi.

UI objects Consulta Actions performed on objects captured with
Universal Recorder alla pagina 1755.

Riferimenti correlati
Actions performed on objects captured with Universal Recorder alla pagina 1755
After capturing the object, specify the action for the bot to do to the object at runtime. Ad esempio,
se acquisisci un collegamento ipertestuale, puoi selezionare un'azione per fare clic sul collegamento o
recuperarne il testo. Refer to the table below for the objects and their possible actions.

Google Chrome browser extension requirements
Assicurati che l'estensione di Automation Anywhere Google Chrome che stai utilizzando corrisponda alla
versione nel package Recorder dei tuoi bots.
Automation Anywhere ha creato due versioni dell'estensione Google Chrome, in base alla versione
del package Recorder. Automation Anywhere La versione 1.1.0.1 dell'estensione A2019 è
l'estensione Google Chrome per i bots che contengono actions dal package Recorder versione
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2.0.6 e successive. Automation AnywhereLa versione 11 o 12 dell'estensione Google Chrome è richiesta
solo per eseguire bots che contengono actions dal package Recorder versione 2.0.5 e precedenti.
Use the table below to verify that your system is running the correct browser agent and Google Chrome
extension.
• Verifica l'agente del browser nella scheda Gestione attività di Windows > Dettagli.

If the browser agent is in the Task Manager, but is not running:
1. Verify that the ComSpec variable is defined in the Environment Variables list.

È possibile individuare tale elenco in Risorse del computer > Proprietà > Impostazioni di
sistema avanzate > Variabili di ambiente.

2. If the ComSpec variable is not in the list, define it by specifying the Variable Name as ComSpec
and the Variable Value as %SystemRoot%\system32\cmd.exe.

• Verifica la versione dell'estensione Google Chrome in chrome://extensions/.
• If necessary, install the Google Chrome extension using the links in the table below.

Ri-verifica di Google Chrome: Google Chrome richiede una nuova verifica delle autorizzazioni quando
l'estensione Automation Anywhere Google Chrome viene aggiornata. Se richiesto, fai clic su Abilita
questo elemento nel messaggio di Google Chrome. Alternatively, re-enable the extension through the
links in the table above. Similarly, if you are deploying your Bot Runners from a master image, accept the
permission from within that image.

Recorder package version Browser agent Google Chrome extension and
ID

2.0.5 or earlier Automation.BrowserAgent.exeVersione 11 o 12

ID:
jjpdebaihkangkfpbgefmnnlafkahebn

2.0.6 o successiva Automation.Bot.BrowserAgent.exeVersione 1.1.0.1 o successiva

ID:
kammdlphdfejlopponbapgpbgakimokm

Nota:  If you upgrade the Bot Agent version by uninstalling the Bot Agent instead of directly upgrading,
this also uninstalls the Google Chrome extension. In that case, you must manually reinstall the Google
Chrome extension.

Se si verifica un errore durante la registrazione o l'esecuzione di un bot che automatizza le attività in un
browser Google Chrome e hai installato Google Chrome, devi eseguire ulteriori passaggi per configurare il
sistema. Consulta Google Chrome extension troubleshooting alla pagina 1960.
Riferimenti correlati
Google Chrome extension troubleshooting alla pagina 1960
Se si verifica un errore durante la registrazione o l'esecuzione di un bot che automatizza le attività in un
browser Google Chrome e hai installato Google Chrome, devi eseguire ulteriori passaggi per configurare il
sistema.

Google Chrome extension troubleshooting
Se si verifica un errore durante la registrazione o l'esecuzione di un bot che automatizza le attività in un
browser Google Chrome e hai installato Google Chrome, devi eseguire ulteriori passaggi per configurare il
sistema.
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Prerequisiti

Assicurati che l'estensione di Automation Anywhere Google Chrome che stai utilizzando corrisponda alla
versione nel package Recorder dei tuoi bots. See Google Chrome browser extension requirements alla pagina
1959.
To configure your system to run the Google Chrome extension, choose the scenario that applies to you and
follow the steps.

package Recorder versione 2.0.9 o successiva:

1. Verifica che la versione 1.1.0.1 o superiore dell'estensione Google Chrome sia installata e abilitata.
Per installare l'estensione, consultare versione 1.1.0.1 o successiva.

2. Open the Windows registry to the Google Chrome browser agent: Computer
\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Google\Chrome\NativeMessagingHosts
\automation.bot.browseragent

3. Verify that the registry entry points to the Automation 360 Bot Agent installation directory:
C:\Program Files\Automation Anywhere\Bot Agent\AABrowserAgent
\AAChromeAgentManifest.json

If this configuration is missing, reinstall the Bot Agent.

package Recorder versione 2.0.6, 2.0.7 o 2.0.8 (per versione A2019.16 o
precedente)

1. Open the Windows registry to the Google Chrome browser agent: Computer
\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Google\Chrome\NativeMessagingHosts
\automation.chrome.agent

2. Verify that the registry entry points to the Automation 360 global cache: C:\ProgramData
\AutomationAnywhere\GlobalCache\embedded-resources\<Recorder package
 version>\AAChromeAgentManifest.json

Ad esempio, C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-
resources\2.0.6-20200626-193519-1bd6fceb-b036-4202-9932-4dc18349bd5c
\AAChromeAgentManifest.json

If this configuration is missing, do the following steps as an admin:
a. Open the Automation 360 global cache: C:\ProgramData\AutomationAnywhere

\GlobalCache\embedded-resources\<Recorder package version>

b. Esegui il file install.ps1.
c. Repeat steps 2 and 3 to verify the registry entry is updated.

package Recorder versione 2.0.5 o precedente e mai installato Automation
Anywhere Enterprise Version 11.3 o successiva

Nota:  Use latest Recorder package version available in your Control Room.
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1. Verify that Google Chrome extension version 11 or 12 is installed and enabled.
Per installare l'estensione, vedere versione 11 o 12.

2. Open the Windows registry to the Google Chrome browser agent:
Computer\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Google\Chrome
\NativeMessagingHosts\automation.chrome.agent

3. Verify that the registry entry points to the Automation 360 global cache: C:\ProgramData
\AutomationAnywhere\GlobalCache\embedded-resources\<Recorder package
 version>\AAChromeAgentManifest.json

Ad esempio, C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-
resources\2.0.5-20200626-193519-1bd6fceb-b036-4202-9932-4dc18349bd5c
\AAChromeAgentManifest.json

If this configuration is missing, do the following steps as an admin:
a. Open the Automation 360 global cache: C:\ProgramData\AutomationAnywhere

\GlobalCache\embedded-resources\<Recorder package version>

b. Esegui il file install.ps1.
c. Repeat steps 2 and 3 to verify the registry entry is updated.

4. Verify that the browser agent Automation.BrowserAgent.exe is running with the Google Chrome
extension installed and enabled.
If this configuration is missing, restart Google Chrome. Puoi disabilitare e abilitare l'estensione Google
Chrome oppure chiudere tutte le schede del browser Google Chrome e riaprire una nuova finestra.

package Recorder versione 2.0.5 o precedente e installato Automation
Anywhere Enterprise Version 11.3 o successiva

1. Verify that Google Chrome extension version 11 or 12 is installed and enabled.
Per installare l'estensione, vedere versione 11 o 12.

2. Open the Windows registry to the Google Chrome browser agent: Computer\HKEY_CURRENT_USER
\Software\Google\Chrome\NativeMessagingHosts\automation.chrome.agent

• If the above key is available, disable the Google Chrome plug-in version 11.x and enable the
Google Chrome plug-in version 12.x.

• If the above key is not available, disable the Google Chrome plug-in version 12.x and enable the
Google Chrome plug-in version 11.x.

3. Restart Google Chrome. Puoi disabilitare e abilitare l'estensione Google Chrome oppure chiudere tutte
le schede del browser Google Chrome e riaprire una nuova finestra.

4. Verifica che l'agente browser Automation.BrowserAgent.exe sia in esecuzione con l'estensione
Google Chrome installata e abilitata.

Automation Anywhere Enterprise Version 11.3 o successiva è disinstallato

Uninstalling the Enterprise Client does not remove the Google Chrome extension and registry entries. To
remove them manually, do these steps:
1. Disable Google Chrome extension 12.x.
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2. Install and enable Google Chrome extension 11.x.
3. In the Windows registry editor, remove the following key: Computer\HKEY_CURRENT_USER

\Software\Google\Chrome\NativeMessagingHosts\automation.chrome.agent

4. Open the Windows registry to the Google Chrome browser agent:
Computer\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Google\Chrome
\NativeMessagingHosts\automation.chrome.agent

5. Verify that the registry entry points to the Automation 360 global cache: C:\ProgramData
\AutomationAnywhere\GlobalCache\embedded-resources\<Recorder package
 version>\AAChromeAgentManifest.json

Ad esempio, C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-
resources\2.0.6-20200626-193519-1bd6fceb-b036-4202-9932-4dc18349bd5c
\AAChromeAgentManifest.json

6. Restart Google Chrome. Puoi disabilitare e abilitare l'estensione Google Chrome oppure chiudere tutte
le schede del browser Google Chrome e riaprire una nuova finestra.

Google Chrome extension installed in Microsoft Edge

Anche se le impostazioni del browser Microsoft Edge consentono le estensioni da Chrome Web Store, si
consiglia di non installare l'estensione Google Chrome nel browser Microsoft Edge. Installing it causes
recording and runtime errors in bots that interact with the Google Chrome browser. Even if you did not
manually install the Google Chrome extension, the auto-sync settings in the Microsoft Edge browser might
have automatically installed the extension.

Impossibile visualizzare l'estensione Google Chrome in modalità non in linea

1. Trascina il file ChromeExtension.crx nella scheda delle estensioni Google Chrome.
Questo file è disponibile nello stesso percorso in cui è disponibile il file
Automation.BrowserAgent.exe.
Enable the Automation 360 Google Chrome extension.
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2. Se l'estensione Google Chrome non è ancora visibile:
a. Verifica se la voce di registro automation.chrome.agent è disponibile nel percorso Computer

\HKEY_CURRENT_USER.
If it is not available, create the registry in the following path: Computer\HKEY_CURRENT_USER
\Software\Google\Chrome\NativeMessagingHosts\automation.chrome.agent

This entry should have the same path as the entry: Computer\HKEY_LOCAL_MACHINE
\Software\Google\Chrome\NativeMessagingHosts\automation.chrome.agent

b. Vai al percorso Computer\HKEY_LOCAL_MACHINE\Software\Google\Chrome
\Extensions.
Per l'ID di estensione di Automation 360 Google Chrome 11.1.0.0
jjpdebaihkangkfpbgefmnnlafkahebn, crea una nuova stringa con il nome percorso.
Il valore della stringa sarà il percorso di ChromeExtension.crx, disponibile nella stessa cartella
in cui è disponibile il file AAChromeAgentManifest.json.
Ad esempio, aggiungi la voce C:\ProgramData\AutomationAnywhere\GlobalCache
\embedded-resources\2.0.5-20200511-172840-1825fd43-19bc-4dd2-
ac56-53a2aed4b0e4\ChromeExtension.crx nelle seguenti posizioni:
• Computer\HKEY_LOCAL_MACHINE\Software\Google\Chrome

\Extensions(ExtensionID)
• Computer\HKEY_CURRENT_USER\Software\Google\Chrome

\Extensions(ExtensionID)

c. Restart Google Chrome. Puoi disabilitare e abilitare l'estensione Google Chrome oppure chiudere
tutte le schede del browser Google Chrome e riaprire una nuova finestra.

Secure recording mode
Quando la modalità di registrazione sicura è abilitata, i bots non acquisiscono i valori di alcune proprietà
né memorizzano immagini dell'applicazione. This ensures that sensitive data is not stored in the bots. This
setting only applies to bots that are created or edited after the mode is enabled.
A user with admin privileges must enable secure recording mode. Consulta Impostazioni alla pagina 2721.
To capture objects in secure recording mode, ensure that the Recorder package is set to
2.0.0-20200318-020414 or higher. Consulta Manage Control Room packages alla pagina 2650.
When you record a task in secure recording mode, the Preview window temporarily shows the captured
area. This image is deleted after you close the bot.
When you record a task in secure recording mode, you can choose whether or not the captured images are
available for preview and stored in the Control Room. Vedi Registrazione sicura alla pagina 37

Nota:  Ensure that you use the latest version of the Recorder package. If you are using the
2.7.3-20220527-004608 or an older version of the Recorder package, a preview of the images will be
shown in the Bot editor when the objects are captured. The images will be discarded when you refresh the
Bot editor.

You can update the following object properties after capturing an object:
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Tecnologia Object property

Microsoft Active Accessibility/UI automation/Java • Nome elemento
• Item value
• Nome
• Parent
• Valore

HTML • Testo interno HTML
• Nome HTML
• HTML value

Microsoft UI Automation (COM) • Descrizione
• Immagine
• Valore
• Nome
• Parent
• Nome elemento
• Item value
• Data provider
• Content
• Legacy name
• Legacy value
• Legacy description

Recording tasks in applications that run on JRE
Use the Universal Recorder to capture objects from Java applet, web start, and desktop applications that
run using Java Runtime Environment (JRE) 6, 7, 8, 9, 10, and 11.
Automation 360 supports JRE 6 and later on both 32-bit and 64-bit systems.
Verify whether additional configuration is necessary, depending on the JRE version:
• If JRE 7 update 6 or later is installed on the registered device, Java Access Bridge is automatically

installed on that device.
• If JRE 7 update 5 or earlier is installed on the registered device, you must manually copy the required

files to the corresponding directories. Consulta Java Access Bridge.
• If you have more than one version of JRE, Automation 360 configures Java Access Bridge with the

default version. To configure it to a different version, you must manually copy the required files to the
corresponding directories. Consulta Java Access Bridge.

The first time you record a task in an application running on JRE 6 or 7 update 5 or earlier, an error
message might appear if the application is launched before Java Access Bridge is installed. Restart the
application and proceed with recording the task.

AISense per la registrazione di attività da applicazioni remote
AISense è la funzionalità basata sull'intelligenza artificiale (IA) di Automation 360 che consente di
identificare oggetti da un'immagine o da un'applicazione con un'interfaccia utente (UI) complessa e rende
l'automazione in tutti gli ambienti più veloce e precisa.
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AISense è adatta quando l'automazione basata su oggetti non riesce o non è efficiente per automatizzare
le attività sulle applicazioni a cui si accede in remoto, in un ambiente Citrix e nelle applicazioni legacy.
Alcuni dei problemi che influiscono sulla precisione di un'attività di automazione in un ambiente remoto
sono i seguenti:
• In un ambiente Citrix, la piattaforma di automazione riceve un'immagine dell'applicazione e non ha

accesso agli elementi dell'interfaccia utente effettivi.
• La risoluzione dello schermo e il dimensionamento potrebbero non essere gli stessi sui computer host e

client.
• La posizione di un elemento dell'interfaccia utente potrebbe cambiare per le applicazioni Web a causa di

una diversa risoluzione sul computer Bot Runner.

AISense uses computer vision to intelligently create dynamic linking between objects by determining
their composition to deliver change-resilient automation. AISense enables you to accurately automate
applications even when labels and text change their position.

Importante:
• I Bots non riusciranno se contengono actions dalle versioni del package Recorder

2.0.9-20201105-164103 o successive e dal package AISense. You must delete the AISense actions and
recapture the objects using the integrated recorder icon. An integrated Recorder alla pagina 1948

• AISense Recorder supporta le seguenti lingue: English, Simplified Chinese, Korean, Brazilian-
Portuguese, Japanese, and Russian. Quando si registra un'applicazione, assicurarsi che il locale del
dispositivo sia impostato sulla stessa lingua dell'applicazione, indipendentemente dal sistema operativo
e dal layout della tastiera. Se l'interfaccia utente (UI) dell'applicazione è una combinazione di inglese e
un'altra lingua, imposta il locale del dispositivo sull'altra lingua. Per esempio, se l'UI è una combinazione
di inglese e russo, imposta il locale del dispositivo sul russo.

Nota:  Anche se il locale del dispositivo è impostato su una lingua diversa dall'inglese, è possibile
continuare ad automatizzare le applicazioni che hanno un'interfaccia utente inglese senza cambiare il
locale del dispositivo in inglese.

Recommendation:  On any application, regardless of the language of the application, when you use the
Get text action to retrieve text from a specified area, if the retrieved text is not accurate, we recommend
that you perform one of the following actions and then record again:
• Increase the font size.
• Decrease the screen resolution.
• Zoom in to capture the text correctly.

Attività correlate
Record a task with AISense Recorder alla pagina 1966
Use the AISense Recorder to record an end-to-end task on a remote application or an application with a
complex user interface (UI).
Edit a task recorded using AISense alla pagina 1969
After you have recorded a task using the AISense Recorder, you can edit the recorded actions to perform
various actions on the captured objects.

Record a task with AISense Recorder
Use the AISense Recorder to record an end-to-end task on a remote application or an application with a
complex user interface (UI).
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• If you are automating a task using a browser, ensure that auto-fill is disabled for that browser.
• The screen resolution must be set to 1980x1080 or lower.
• Configure the device display settings to 100% DPI.
• If you are using Automation 360 On-Premises, ensure that the AISense Recorder package is added to

your Control Room.

AISense Recorder can capture the following objects from an application: text boxes, buttons, radio
buttons, combo boxes, check boxes, active and passive text, image button, scroll, and combo box.
Keep the following considerations in mind when recording a task:
• Record the task at low speed.
• Avoid dragging windows during the recording process.
• Avoid clicking applications that are not part of the process you are recording to automate.

To record a task using the AISense Recorder, follow these steps:
1. From Automation Anywhere web interface left panel, click Automation.
2. Create a new bot or open an existing bot for which you want to record a task.
3. Click Start recording.

Nota:  In versions 2.0.9-20201105-164103 and later, the Recorder package contains both the
Universal Recorder and AISense Recorder.
An integrated Recorder alla pagina 1948

The Automation Anywhere Recorder window appears.
4. Select a window from the drop-down list.

If you opened an application recently and it is not available in the list, click the Refresh icon.
5. Click AISense Recorder.

The first time you use the AISense Recorder on a device, the Recorder downloads the required
dependencies.
The Recorder toolbar appears with Finish, Scan, Define, and Pause options.
The Recorder analyzes the application window you selected to identify the UI objects in that window.
The options on the toolbar are disabled when the system is analyzing the application window. After
the analysis, the options are enabled and you can start recording the task.

6. Perform the actions to record. For example, click buttons, fill in forms, or select an option.
To perform an action on an object, move the mouse pointer on that object. The system highlights
an object along with the text associated with that object. For example, when you move the mouse
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pointer over a button or check box, the associated text with that button or check box is also
highlighted and captured.
• If the object is not highlighted, click the Scan option on the recording toolbar. After the system

finishes analyzing the application window, you can capture the required object.
• If you want to capture an option from a list, click the list and wait until the highlight appears

around the box containing the options. After the box is highlighted, move the mouse pointer over
the option you want to capture and wait until the option is highlighted.

• If you use scroll on an application window, you must click Scan to analyze the new objects on the
window.

• If you want to record an interaction with an object that is only visible when you hover the mouse
over the object, see Detect hidden objects manually

The Recorder window contains the number of operations recorded and a description of the most
recently captured object. For example, 5. Left click on button 'Submit'.
To redo the previous object capture, click the Delete icon at the bottom right of the Recorder
window to discard the most recent capture.
If Secure recording mode is enabled, a shield icon appears to the right of the red recording icon.
Secure recording mode alla pagina 1964

7. Click Finish after you finish capturing all the necessary objects.
A Capture action is generated for each operation.
Where applicable, the Recorder generates variables. Le tue variabili (definite dall'utente) alla pagina
2026

8. Edit the actions or click Save.
Edit a task recorded using AISense alla pagina 1969

Detect hidden objects manually
If an object is only visible when you hover the mouse over the object, you must manually specify the
object type and location by anchoring it to the nearest text:
1. Click the object once.
2. Click Define.

The AISense Define main object window appears with a screenshot of the application, where the
object is visible.

3. Click and drag a rectangle to outline the object to capture.
4. In the Supporting anchor list, select the text that is closest to the object you are capturing.
5. Fai clic su Applica.

Attività correlate
Edit a task recorded using AISense alla pagina 1969
After you have recorded a task using the AISense Recorder, you can edit the recorded actions to perform
various actions on the captured objects.
Riferimenti correlati
AISense per la registrazione di attività da applicazioni remote alla pagina 1965
AISense è la funzionalità basata sull'intelligenza artificiale (IA) di Automation 360 che consente di
identificare oggetti da un'immagine o da un'applicazione con un'interfaccia utente (UI) complessa e rende
l'automazione in tutti gli ambienti più veloce e precisa.
Actions performed on objects captured with AISense Recorder alla pagina 1970
After you capture objects using the AISense Recorder, you can perform various actions that a bot can
perform on the object at runtime.
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Edit a task recorded using AISense
After you have recorded a task using the AISense Recorder, you can edit the recorded actions to perform
various actions on the captured objects.
Edit a recorded task to do the following:
• Change the application window in which you want to perform the operation, or add a wildcard to the

window title.
• Change the properties of the captured objects.
• Specify the action you want to perform on the captured objects.
• Introduce a delay before the next action is performed.
• Specify the variable you want to use to store the output.

Importante:  Only the following types of objects are supported with AISense Recorder:
• Text boxes
• Check boxes
• Combo boxes
• Radio buttons
• Buttons
• Active text

Active text is the text that you can click. For example, link, menu, text on a navigation pane, and so on.
Quando nella finestra sono presenti testi attivi duplicati, il AISense Recorder identifica e applica l'azione
della prima occorrenza del testo attivo nella finestra.

• Passive text
Passive text is the text that you can only read. Può essere qualsiasi testo visibile nella finestra che può
essere associato a un testo di ancoraggio statico nelle vicinanze disponibile durante l'esecuzione di un
bot. Quando si seleziona un'area con più righe, il AISense Recorder recupera solo la prima riga del testo
dall'area.

• Image button
An image button is a button that contains only image and does not have any text associated with it. For
example, icons for delete, copy, cut, paste, and so on. You can capture image buttons that are hidden
on the application screen and appear when you hover the mouse pointer over them.

• Scroll on an application window and combo box

To edit a recorded task, perform the following steps:
1. Open the bot that contains the recorded actions you want to edit.
2. Click the Capture action that you want to edit.
Make the following changes, as necessary:
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3. Fai clic sulla scheda Finestra o sulla scheda Variabile per specificare una finestra dell'applicazione
diversa in cui desideri eseguire l'operazione.
Se è stata utilizzata la scheda Finestra per specificare la finestra dell'applicazione, puoi utilizzare
un carattere jolly nel campo Titolo della finestra. The wildcard character is useful if the title of an
application changes. Ad esempio, Campione* - Google Chrome.

Nota:
• During runtime, verify that the TaskBot identifies the correct window.
• Se utilizzi lo scorrimento in una finestra dell'applicazione, è necessario fare clic su Analizza

finestra  per analizzare i nuovi oggetti nella finestra.

4. Update the object properties.
Puoi aggiornare solo il valore disponibile nel campo Ancoraggio.

5. Seleziona un'opzione dall'elenco Azione per specificare l'action che desideri eseguire sull'oggetto.
For a full list of possible actions by object, see Actions performed on objects captured with AISense
Recorder alla pagina 1970.

6. Opzionale: Immetti un valore nel campo Attendi il controllo per specificare il numero di secondi che
il bot deve attendere affinché il controllo dell'oggetto venga visualizzato nella finestra dell'applicazione.
Si consiglia di impostare un tempo di ritardo quando si utilizza l'azione Imposta testo per immettere i
tasti in un campo di testo.

7. Opzionale: Assign the output to a variable.
The Control Room suggests a descriptive default variable name based on the action that you selected
previously. For example, if you selected Get text, the suggested output variable is CaptureText.
If you create several output variables, subsequent variable names are suffixed with a hyphen and
number to prevent duplication of variable names.

8. Perform the Steps 2 through 7 for the other actions that you want to edit in the bot.
9. Fai clic su Salva.

Link nearby text to a supporting anchor
At run time, if the bot cannot reliably identify an object, link the object to nearby text that is easier for the
bot to find:
1. Apri l'action Acquisisci.
2. Fai clic sulla scheda Ancoraggio.
3. Fai clic su Acquisisci ancoraggio.

La finestra del browser o dell'applicazione si attiva con l'oggetto principale evidenziato (l'oggetto
precedentemente acquisito). Appare una finestra di dialogo che verifica se l'azione ha identificato
correttamente l'oggetto principale.

4. Se l'oggetto corretto è evidenziato, fai clic su Sì, seleziona ancoraggio.
Altrimenti, fai clic su No, devo correggerlo per selezionare l'oggetto corretto.

5. Select nearby text to the target object that is easier for the bot to find.
The text is highlighted with an anchor icon to the right of the text.

6. Fai clic su Salva.

Actions performed on objects captured with AISense Recorder
After you capture objects using the AISense Recorder, you can perform various actions that a bot can
perform on the object at runtime.
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For example, when you capture a button, you can select to click the button or to retrieve the button text.
The following table lists the objects and their possible actions.

Oggetto Azioni

Pulsante • Ottieni testo: Extracts the value or caption from the specified
captured object.

• Fai clic: Use this action to select the captured object.
• Clic sinistro: utilizza questa azione se l'azione Clic non funziona

durante il runtime.
• Clic destro: Use this action to perform the right-click operation on the

captured object.
• Doppio clic: Use this action to perform the double-click operation on

the captured object.

Image button • Clic sinistro: utilizza questa azione se l'azione Clic non funziona
durante il runtime.

• Clic destro: Use this action to perform the right-click operation on the
captured object.

• Doppio clic: Use this action to perform the double-click operation on
the captured object.

Active text • Clic sinistro: utilizza questa azione se l'azione Clic non funziona
durante il runtime.

• Clic destro: Use this action to perform the right-click operation on the
captured object.

• Doppio clic: Use this action to perform the double-click operation on
the captured object.

Passive text Ottieni testo: Retrieves text available in the area you have specified.

Casella di controllo • Ottieni testo: Extracts the value or caption from the specified
captured object.

• Ottieni stato: Retrieves whether the check box is selected. Returns
checked or unchecked.

• Spunta: Selects the captured check box.
• Deseleziona: Clears the captured check box.
• Toggle: Sswitches the check box to the opposite status. Ad

esempio, se la casella di controllo è selezionata, utilizza l'Toggle per
deselezionarla.

• Clic sinistro: utilizza questa azione se l'azione Toggle non funziona
durante il Runtime.

• Clic destro: Use this action to perform the right-click operation on the
captured object.

• Doppio clic: Use this action to perform the double-click operation on
the captured object.
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Oggetto Azioni

Combo box (appears as
a drop-down list)

• Ottieni testo: Extracts the value or caption from the specified
captured object.

• Ottieni testo selezionato: Retrieves text from the selected item.
• Seleziona elemento per testo: Seleziona l'elemento che corrisponde

al testo specificato nel campo Assegna valore.

Nota:  Il campo Assegna valore è sensibile alla distinzione tra
maiuscole/minuscole.

• Espandi: Expands the combo box.
• Fai clic: Use this action to select the captured object.
• Clic sinistro: utilizza questa azione se l'azione Clic non funziona

durante il runtime.
• Clic destro: Use this action to perform the right-click operation on the

captured object.
• Doppio clic: Use this action to perform the double-click operation on

the captured object.

Scroll bar (within a
combo box)

• Scorri su: Performs the scroll up operation. This action is similar to
clicking the scroll up button one time.

• Scorri giù: Performs the scroll down operation. This action is similar to
clicking the scroll down button one time.

• Pagina su: Performs the page up operation. This action is similar to
holding the scroll bar and moving it up. La distanza per cui la barra
di scorrimento viene spostata verso l'alto è specificata nel campo
Distanza di scorrimento.

• Pagina giù: Performs the page down operation. This action is similar
to holding the scroll bar and moving it down. La distanza per cui la
barra di scorrimento viene spostata verso il basso è specificata nel
campo Distanza di scorrimento.

• Clic sinistro: utilizza questa azione se l'azione Clic non funziona
durante il runtime.

• Clic destro: Use this action to perform the right-click operation on the
captured object.

• Doppio clic: Use this action to perform the double-click operation on
the captured object.

RadioButton • Ottieni testo: Extracts the value or caption from the specified
captured object.

• Ottieni stato: Retrieves whether the radio button is selected. Returns
selected or deselected.

• Seleziona: Use this action to select the captured radio button.
• Clic sinistro: utilizza questa azione se l'azione Clic non funziona

durante il runtime.
• Clic destro: Use this action to perform the right-click operation on the

captured object.
• Doppio clic: Use this action to perform the double-click operation on

the captured object.
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Oggetto Azioni

TextBox • Ottieni testo: Extracts the value or caption from the specified
captured object.

• Imposta testo: Enters the text you have specified in the captured
field. It supports credentials.
Credentials and credential variables in the Bot editor alla pagina 2039

• Aggiungi testo: Adds text at the end of existing text in the captured
field, instead of overwriting it.

• Fai clic: Use this action to select the captured object.
• Clic sinistro: utilizza questa azione se l'azione Clic non funziona

durante il runtime.
• Clic destro: Use this action to perform the right-click operation on the

captured object.
• Doppio clic: Use this action to perform the double-click operation on

the captured object.

Capture Image button through AISense Recorder
Image buttons or icons are clickable buttons with no anchors. An application can have one or multiple
image buttons. AISense Recorder uses template matching to detect and match image buttons on an
application. So even after you record, if the position of the image button changes due to window resizing,
AISense Recorder can detect the object and run the bot.

Capture Image button

1. Nel pannello di sinistra, fai clic su Automazione.
2. To create a bot, click Create new > Bot, or open a bot for which you want to record a task.
3. Click Start recording.

The Recorder bot runtime window appears.
4. Select a window from the drop-down list.

If you opened an application recently and it is not available in the list, click the Refresh icon.
5. Click AISense Recorder and allow the scanning process to finish.

Nota:  The AISense Recorder downloads the required dependent files the first time you use it on a
device.

The AISense Recorder toolbar appears with these options: Finish, Scan, Define, and Pause.
The AISense Recorder analyzes the selected application window to identify the UI objects in that
window. When the system is analyzing the application window, the options on the toolbar are
unavailable. After the analysis completes, the options are enabled and you can start recording the
task.

6. Wait for the AISense Recorder to detect the object.
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7. If the object is not detected automatically, then when the AISense Recorder reaches the Ready state,
you can click the Define button to detect the object.

Nota:
• In the Define window, the  shows embedded help for each control type so you can select the

correct control types for custom objects.
• If you unintentionally click the screen or click before the highlighter appears,  provides visibility

into it. You must confirm to capture the object again, or use the Define functionality to define the
object on the screen.

.

8. Select Image button from the Select the object type for the selected area tab.

9. Draw a rectangle around the image button that you want to capture.
The selected area is shown in the box below the Drag and select the area which you want to
define from the image field.
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10. Hover the mouse cursor over the nearby static text. Once the text is highlighted, select the static text
as the supporting anchor.
The image of the anchor is shown in the box below the Select one supporting anchor point for
the selected area field.

11. Click Define.
12. After you have captured the required objects, click Finish.

Capture link button through AISense Recorder
The link button control is clickable and has no specific features. In some cases, the AISense Recorder
cannot detect it. You must use the Define option to detect and capture the link button control.

Capture link button

1. Nel pannello di sinistra, fai clic su Automazione.
2. To create a bot, click Create new > Bot, or open a bot for which you want to record a task.
3. Click Start recording.

The Recorder bot runtime window appears.
4. Select a window from the drop-down list.

If you opened an application recently and it is not available in the list, click the Refresh icon.
5. Click AISense Recorder and allow the scanning process to finish.

Nota:  The AISense Recorder downloads the required dependent files the first time you use it on a
device.

The AISense Recorder toolbar appears with these options: Finish, Scan, Define, and Pause.
The AISense Recorder analyzes the selected application window to identify the UI objects in that
window. When the system is analyzing the application window, the options on the toolbar are
unavailable. After the analysis completes, the options are enabled and you can start recording the
task.

6. Wait for the AISense Recorder to detect the object.
7. If the object is not detected automatically, then when the AISense Recorder reaches the Ready state,

you can click the Define button to detect the object.

Nota:
• In the Define window, the  shows embedded help for each control type so you can select the

correct control types for custom objects.
• If you unintentionally click the screen or click before the highlighter appears,  provides visibility

into it. You must confirm to capture the object again, or use the Define functionality to define the
object on the screen.

.
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8. Select Link from the Select the object type for the selected area tab.

9. Draw a rectangle around the link button that you want to capture.
The selected area is shown in the box below the Drag and select the area which you want to
define from the image field.

10. Hover the mouse cursor over the text. Once the text is highlighted, select the link text as the
supporting anchor.
The image of the anchor is shown in the box below the Select one supporting anchor point for
the selected area field.

11. Click Define.
12. After you have captured the required objects, click Finish.

Capture text value through AISense Recorder
Passive texts are texts that are readable only. To make decisions, bots might require extracting texts,
for example, key-value pair or text value from a form. If the AISense Recorder cannot detect the texts
automatically, then you must use the Define option to detect the texts.
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Capture the text value

1. Nel pannello di sinistra, fai clic su Automazione.
2. To create a bot, click Create new > Bot or open a bot for which you want to record a task.
3. Click Start recording.

The Recorder bot runtime window appears.
4. Select a window from the drop-down list.

If you opened an application recently and it is not available in the list, click the Refresh icon.
5. Click AISense Recorder and allow the scanning process to finish.

Nota:  The AISense Recorder downloads the required dependent files the first time you use it on a
device.

The AISense Recorder toolbar appears with these options: Finish, Scan, Define, and Pause.
The AISense Recorder analyzes the selected application window to identify the UI objects in that
window. When the system is analyzing the application window, the options on the toolbar are
unavailable. After the analysis completes, the options are enabled and you can start recording the
task.

6. Wait for the AISense Recorder to detect the object.
7. If the object is not detected automatically, then when the AISense Recorder reaches the Ready state,

you can click the Define button to detect the object.

Nota:
• In the Define window, the  shows embedded help for each control type so you can select the

correct control types for custom objects.
• If you unintentionally click the screen or click before the highlighter appears,  provides visibility

into it. You must confirm to capture the object again, or use the Define functionality to define the
object on the screen.

.

8. Select Text value from the Select the object type for the selected area tab.
9. Draw a rectangle around the text area that you want to extract.

The selected area is shown in the box below the Drag and select the area which you want to
define from the image field.

10. Hover the mouse cursor over the nearby static text. Once the text is highlighted, select the static text
as the supporting anchor.
The image of the anchor is shown in the box below the Select one supporting anchor point for
the selected area field.

11. Click Define.
12. After you have captured the required objects, click Finish.
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Known behavior

AISense Recorder cannot extract texts with multiple lines. If you select multiple lines, only the first line is
extracted.

Capture Textbox, Radio, Checkbox, and Combobox
When a screen is dense, sometimes the AISense Recorder cannot detect and classify the controls correctly.
To continue to automate the controls seamlessly, you can use the AISense Recorder to capture coordinates
of controls and perform certain actions without having to use the Mouse and Simulate keystrokes packages
separately.

Textbox, Radio, Checkbox, and Combobox

Nota:  Any textbox, radio, checkbox, and combobox controls captured using Define functionality will be
coordinate based automation. This functionality is provided for continuity of workflow.

1. Nel pannello di sinistra, fai clic su Automazione.
2. To create a bot, click Create new > Bot or open a bot for which you want to record a task.
3. Click Start recording.

The Recorder bot runtime window appears.
4. Select a window from the drop-down list.

If you opened an application recently and it is not available in the list, click the Refresh icon.
5. Click AISense Recorder and allow the scanning process to finish.

Nota:  The AISense Recorder downloads the required dependent files the first time you use it on a
device.

The AISense Recorder toolbar appears with these options: Finish, Scan, Define, and Pause.
The AISense Recorder analyzes the selected application window to identify the UI objects in that
window. When the system is analyzing the application window, the options on the toolbar are
unavailable. After the analysis completes, the options are enabled and you can start recording the
task.

6. Wait for the AISense Recorder to detect the object.
7. If the object is not detected automatically, then when the AISense Recorder reaches the Ready state,

you can click the Define button to detect the object.

Nota:
• In the Define window, the  shows embedded help for each control type so you can select the

correct control types for custom objects.
• If you unintentionally click the screen or click before the highlighter appears,  provides visibility

into it. You must confirm to capture the object again, or use the Define functionality to define the
object on the screen.

.

8. Select the specific object type from the list of object types from the Select the object type for the
selected area tab.
The object types that you select is shown under Current selection.
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9. Draw a rectangle around the control that you want to capture.
The selected area is shown in the box below the Drag and select the area which you want to
define from the image field.

10. Hover the mouse cursor over the text. Once the text is highlighted, select and define the text as the
supporting anchor for identification.
The image of the anchor is shown in the box below the Select one supporting anchor point for
the selected area field.

11. Click Define.
12. After you have captured the required objects, click Finish.

Table data extraction through AISense Recorder
Tables are a complex control, with many types, backgrounds, and formatting effects, and hence might not
be automatically detected by AISense Recorder in some cases. In such cases, use the Define option to
detect tables.

Capture a table using AISense Recorder

1. Nel pannello di sinistra, fai clic su Automazione.
2. To create a bot, click Create new > Bot or open a bot for which you want to record a task.
3. Click Start recording.

The Recorder bot runtime window appears.
4. Select a window from the drop-down list.

If you opened an application recently and it is not available in the list, click the Refresh icon.
5. Click AISense Recorder. Let the scanning process finish.

Nota:  The first time you use AISense Recorder on a device, the Recorder downloads the required
dependent files.

The Recorder toolbar appears with the following options: Finish, Scan, Define, and Pause
The Recorder analyzes the application window that you selected to identify the UI objects in that
window. The options on the toolbar are unavailable when the system is analyzing the application
window. After the analysis, the options are enabled and you can start recording the task.

6. Wait for AISense Recorder to detect the table in the application.
7. If the table is not detected automatically, then when AISense Recorder is in the Ready state, click the

Define button to detect the table.

Nota:
• In the Define window, the  shows embedded help for each control type so you can select the

correct control types for custom objects.
• If you unintentionally click the screen or click before the highlighter appears,  provides visibility

into it. You must confirm to capture the object again, or use the Define functionality to define the
object on the screen.

.

8. Select Table from the Object type tab and click the top-left header.
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The detected table will be highlighted with columns and internal controls.
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9. If you want to select a limited set of columns, then draw a rectangle around the columns that you
want to capture.

Extract data from a table

1. After the object is captured, click Finish to end the recording.
2. Return to the Control Room.
3. In the Object properties table, verify that the Control Type is TABLE. In caso contrario, fai clic su

Riacquisisci oggetto.
4. From the Action to take on object drop-down list, select Get table.
5. In the Save the outcome to a variable field, create the CapturedTableData variable.
6. Fai doppio clic o trascina l'action Tabella dati > Scrivi su file.
7. From the Data table name list, select CapturedTableData.
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8. Provide a filepath to create a CSV file. For example, C:\AutomationAnywhere\Development
\SFDC.csv

9. Select the Create folders/files if it doesn't exist option.
10. Select to overwrite the existing file.
11. Fai clic su Salva.
12. Fai clic su Esegui.

The bot creates a CSV file in the specified path with the table data extracted.

Correct a column definition

It is possible that dense tables can merge columns due to less space between columns or lack of clear
separators. To correct the column definition, perform the following steps:
1. After the object is captured, click Finish to end the recording.
2. On the Bot editor window, go to Object properties to edit the Anchor Table property.
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3. Add the pipe character (|) as a delimiter between the column names to separate them. For example,
<CHECKBOX>Name|Company|State|Email|Lead status

Nota:  When the bot is run, previously merged columns will be treated as separate columns.

Known behavior

• AISense Recorder cannot extract tables with multiple lines in single rows or cells.
• Pagination and autoscrolling are not supported.
• Truncated columns will not be automatically adjusted to extract truncated cell text.
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Use variable anchor
You can use the variable anchor to automate same controls that have different anchors. For example,
pages having multiple checkboxes with different captions. These captions might be dynamic and might
change based on the workflow. You can use the variable anchor to capture the control once, and then
use the anchor as a variable in the Bot editor window. You can use a variable from various sources, for
example, Microsoft Excel, CSV, or database.

Capture using variable anchor

1. Nel pannello di sinistra, fai clic su Automazione.
2. To create a bot, click Create new > Bot or open a bot for which you want to record a task.
3. Click Start recording.

The Recorder bot runtime window appears.
4. Select a window from the drop-down list.

If you opened an application recently and it is not available in the list, click the Refresh icon.
5. Click AISense Recorder and allow the scanning process to finish.

Nota:  The AISense Recorder downloads the required dependent files the first time you use it on a
device.

The AISense Recorder toolbar appears with these options: Finish, Scan, Define, and Pause.
The AISense Recorder analyzes the selected application window to identify the UI objects in that
window. When the system is analyzing the application window, the options on the toolbar are
unavailable. After the analysis completes, the options are enabled and you can start recording the
task.

6. Wait for the AISense Recorder to detect the object.
7. If the object is not detected automatically, then when the AISense Recorder reaches the Ready state,

you can click the Define button to detect the object.

Nota:
• In the Define window, the  shows embedded help for each control type so you can select the

correct control types for custom objects.
• If you unintentionally click the screen or click before the highlighter appears,  provides visibility

into it. You must confirm to capture the object again, or use the Define functionality to define the
object on the screen.

.
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8. Select Variable anchor from the Select the object type for the selected area tab.

9. Draw a rectangle around the checkbox that you want to capture.
The selected area is shown in the box below the Drag and select the area which you want to
define from the image field.

Nota:  Hover the mouse over the checkbox and ensure that the checkbox is detected and highlighted
with red rectangle before you click Define.

10. Hover the mouse over the closest static text. Once the text is highlighted, select the text as the
supporting anchor.
The image of the anchor is shown in the box below the Select one supporting anchor point for
the selected area field.

11. Click Define.
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12. After you have captured the required objects, click Finish.
The recorded steps appear as a separate action in the bot.
For each variable anchor action, you can copy the added action and update the value in the Anchor
field with the anchor text of the object you want to capture, for each variable anchor action.
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Alternatively, you can use the action within the Loop action and use a variable that supports the String
data type in the Anchor field.
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Nota:
• You can assign only highlighted controls to a variable.
• Ensure no additional control or text exists between the anchor and the control.

Abilita i log di debug per AISense Recorder
È possibile utilizzare i log di debug per risolvere i problemi della finestra dell'applicazione acquisita e per
verificare se l'oggetto viene rilevato correttamente. I risultati sono disponibili come immagini di debug nella
cartella %temp%\AISenseLogs.
1. Sul tuo dispositivo locale, accedi a C:\Program Files\Automation Anywhere\Bot Agent

\config.
2. Apri il file botlauncher-logging.xml.
3. Include the following logger entry within the <Loggers> XML element and save the XML file:

<Logger name="com.automationanywhere.recorder" level="DEBUG"/>
Ad esempio, aggiungi la voce del registratore di debug sotto la voce del registratore esistente.

<Logger name="com.automationanywhere.recorder" level="INFO"/>
<Logger name="com.automationanywhere.recorder" level="DEBUG"/>

Le modifiche apportate al file di configurazione di registrazione vengono aggiornate in secondi
configurati in base al valore dell'intervallo di monitoraggio.

Nota:  Se le modifiche non vengono applicate automaticamente in base al valore dell'intervallo di
monitoraggio, riavvia il servizio Bot Agent.

AISense Recorder best practices
To use the AISense Recorder optimally, review the best practices.

Configuring registered devices

• Ensure you use only recommended hardware configuration for registered device as specified. Vedi
Automation 360 Bot Runner device requirements alla pagina 829

• If application is running on same device, we recommend you to add additional CPU or RAM to avoid
slowness. Vedi Automation 360 Bot Runner device requirements alla pagina 829

• If you are automating a task using a browser, ensure that auto-fill is disabled for that browser.
• Ensure that the screen resolution is set to 1980x1080 or lower. Vedi Record a task with AISense Recorder

alla pagina 1966
• Configure the device display settings to 100% DPI. Vedi Record a task with AISense Recorder alla pagina

1966

Behavior

• When you use the AISense Recorder for the first time on any device, either for recording or for
playback, it downloads the required resources from the Control Room. This process might take a few
or several minutes depending on the speed of your internet. The state of the process is indicated in
the progress bar during recording and the Bot runtime window shows Downloading additional
resources.
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• When you use a new package in a bot and if the package has any updated resources, it gets
downloaded automatically that results in a delay in bot execution.

• There is a delay in scanning or bot execution in the following cases:
• The first execution will setup AISense environment which will take couple of seconds (based on

machine configuration). User will observe some delay in scanning and bot execution.
• Every time application changes, due to navigation or new controls loaded, AISense has to detect

new available controls on the application screen, which will take couple of seconds (based on
machine configuration). User will observe some delay in scanning and bot execution.

• Parent and child bot execution: If child bot is using AISense Recorder, every time the child bot
is executed, an AISense environment gets created to maintain isolation between bots. User will
observe some delay in bot execution.

Methodology

• Record the task at low speed. Click only after the red highlighter appears around the object.
• Avoid dragging the windows during the recording process.
• If AISense Recorder is downloading required resources from the Control Room in case it is deployed for

the first time, do not close the Recorder window in between since doing so might corrupt the required
resource files.

• When the AISense Recorder is in Scanning state, avoid switching between applications.
• When the AISense Recorder is in Ready state, move the mouse slowly over the object or control that

you want to capture and make sure that it gets highlighted with the red rectangle and then click on it.

Capturing Combo box

The following are some best practises that you can follow when you use the AISense Recorder to capture
combo boxes. Below are some of the combo boxes based on the application requirements.
• Searchable combo box: The searchable combo box enables you to click in the text area and type.

It then starts filtering the typed text from the list and allows you to press enter when a single result is
available.
• To automate this combo box control, during recording, highlight the combo box and click in the

center of the combo box. The default action selected will be Select Item by Text. Finish the
recording.

• Go back to control room bot editor. Enter the text value along with Enter or combination of
Down (down arrow) and Enter to simulate user like action. For example, if you are automating a
searchable combo box which has a dropdown list item, then you can either enter the value in the
searchable combo box and click Enter to select it or use the down arrow to search for the specific
value and click Enter to select that value from the list.
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• Legacy combo box: The legacy combo box does not have a search functionality and it is mandatory
to expand it by clicking triangular button on right side of combo box and select one of the value.
• To automate this combo box control, during recording, highlight the combo box, it should also

highlight the small triangular button on right side.

Nota:  Ensure that it also highlights the small triangular button on the right side.

• Click the button and wait.
The Recorder must take sometime to identify expanded value. During this time, the recording icon in
the Recorder window must be in the blinking state.

• As soon as the small recording icon stops blinking, hover the mouse over the list box (expanded
combo box) and make sure it highlights list values.

• Select the specific values.
• User can select any value and and later change it from the Bot editor window in the Automation

Anywhere Control Room.

Using AISense Recorder with other Packages

AISense Recorder is computer vision based object detection method of automating where it captures
the image of the application that you want to automate. When you use AISense Recorder to automate
applications that have objects like textbox with single underline or combobox without triangular button, the
objects might not get detected. In such cases, we recommend you use a combination of AISense Recorder
with other packages like OCR and Image Recognition packages or only OCR and Image Recognition
packages to automate such use cases.

Client Control

AISense Recorder detects object on the application with specific feature set. When you click an area where
there is no control, or click a control before it highlights with red boundaries, it will be recorded as CLIENT
control. The client control is coordinate based capture of mouse click to replicate user click and is not
standard AISense control. We recommend user to recapture control if captured as CLIENT control.

Working with bots
Depending on the license and permission assigned to you, you can perform various bot operations and
access the private and public workspaces in the Control Room.

Licenze

Two types of licenses are available: Bot Creator and Bot Runner (attended or unattended) licenses.
Licenze Automation 360 alla pagina 1010

Bot Creator tasks

A Bot Creator user can access both the private workspace and public workspace in the Control Room
by navigating to Automation on the left panel. The license provides the user exclusive access to the
registered device. Other users cannot use the default device of a Bot Creator.
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With the Bot Creator license and specific permissions, you can perform the following tasks:
• Create a bot
• Run a bot alla pagina 1994
• Record a bot

Record a task with the Universal Recorder alla pagina 1951|Record a task with AISense Recorder alla pagina
1966

• Programmare un bot alla pagina 2616
• Copy a bot alla pagina 2005
• Assign label to a bot
• View bot version history
• Export a bot
• Import a bot
• Check in a bot alla pagina 1997
• Check out a single bot alla pagina 2000
• Delete a bot

You can also edit, analyze, save, clone, view content, pause, or stop a TaskBot.

Bot Runner tasks

A Bot Runner can access only to the public workspace in the Control Room. They cannot create or edit
bots.
With the Bot Runner license and specific permissions, you can perform the following tasks:
• Run a bot alla pagina 1994
• Programmare un bot alla pagina 2616
• Assign label to a bot

You can also view the content of a TaskBot.

Public and private workspaces

The Automation page lists all the folders and bots available within the selected folder in the Public and
Private repositories. If you have migrated the Enterprise 11 or Enterprise 10 data to Automation 360, the
Automation page additionally displays the Enterprise 11 or Enterprise 10 TaskBots (.atmx) and MetaBots
(.mbot) files in the public repository.
When an Enterprise 11 or Enterprise 10 bot is migrated and converted to the Automation 360 bot, the
My Tasks and the My Metabots folders display the migrated (Enterprise 11 or Enterprise 10) and the
converted bots with the same name but different extension. This might create confusion to differentiate
between the two bots. Also, you cannot take any actions on the migrated bots except deleting them. To
avoid this confusion, you can use the Show menu option to show or hide the Enterprise 11 or Enterprise
10 bots.
The Show menu displays three options - Folder, .ATMX Task Bot, and .MBOT Meta Bot. By default,
each of these options are selected and displays all the folders and sub folders along with the Enterprise 11
or Enterprise 10 bot files.
If you clear the selected Folder option, then the sub-folders will be hidden from the files and folders list
and will only display .atmx or .mbot files and when you clear the selected. .ATMX Task Bot or the
.MBOT Meta Bot options, the .atmx or .mbot files, will then be hidden across all the folders.
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Depending on the license, users logging in to the Control Room can access the private and public
workspaces.

Private workspace Users with the Bot Creator license can access the
private workspace. This workspace is primarily used
to create and test bots. It enables users to view and
manage all their activities in one primary location.
Bots in the private workspace is available only to
the users who created them.

Nota:
• Users with administrative privileges and Bot

Runner license cannot access the private
workspace because they cannot create bots.

• Il nome del bot deve essere unico. If a bot or a
folder with the same name exists in the same
folder location which you have access to in the
public workspace, you cannot either create,
check out, or rename the bot with this name in
the private workspace.

Public workspace Both Bot Creator and Bot Runner users can access
the public workspace. This is a shared workspace
where you can execute the bots.
Users with the Bot Runner license can run bots
created by the Bot Creator user. Bots created in the
private workspace by Bot Creators can be made
available to specific Bot Runner users in the public
workspace by defining the permissions at the folder
or file level. To do this, users have to first check in
the bot from the private workspace to the public
workspace.

Nota:
• When you create a TaskBot with dependencies, ensure that both the parent and child bot are in the

same workspace (public or private). You cannot call a public bot from a private bot. To call a bot from
the public workspace, you should first check-out or clone the public bot into the private workspace,
include it as a child bot inside the private bot, and check-in both the bots.

• Folder names in private and public workspaces are case-sensitive. You can create a folder with the
same name and matching case in private and public workspaces. However, you cannot create folders
with the same name but with different case in the workspaces. For example, you can create a folder
My Metabots in both private and public workspace. However, you cannot create folder names that
use the same name but with different case, such as My Metabots in the private workspace and My
MetaBots in the public workspace.

• Sorting and filtering are supported for substrings. For example, if you want to search for bots or files
that have fin in the file or bot name, enter fin as the search criterion. All the bots and files that
contain fin in the names will be displayed, for example, Finance, Finder, DeltaFinance, and Dolfin.
Wildcards are not supported for searching and filtering bots or files.
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Run a bot
You can run a bot to test an automated process.
1. Accedi a Control Room.
2. On the left pane in the public workspace, click Automation.

Viene visualizzato un elenco dei moduli e dei bots disponibili.
3. Select the bot to run. Hover over the actions menu (vertical ellipses) located to the right of the bot

name and click Run Task Bot.
If an optional Bot Agent update for your device is available, the following message that Bot Agent has
an update is displayed one time per user session or when you log out and log in to the Control Room.

• To download and update the Bot Agent to the latest version on your device, use the Click here
link.

• To opt out of the update and continue with the existing Bot Agent version on your device, click
Continue without update.

4. Select the version of the bot to run.
• Versione più aggiornata: To select the latest version of the bot, click the Latest version tab.
• Versione con etichetta: To select the labeled version of the bot, click the Production version tab.

By default, the latest version of the bot is selected. Se l'opzione etichetta di produzione è selezionata
per il bot padre, vengono selezionati automaticamente anche i corrispondenti bots dipendenti
con l'etichetta di produzione. Se uno qualsiasi dei bots dipendenti non ha l'etichetta di produzione
applicata, viene selezionata la versione più aggiornata del bot.

5. Click the right arrow (→) to add your selection.
6. Select the Bot Runner users from the list of Available bot runners in the Run as tab.

The list of Bot Runner users that you have access to are displayed.
7. Click the right arrow (→) to add your selection.
8. Select the pool from the list of Available device pools in the Device pools tab.

The list of device pools for which you have a consumer role are displayed. Select the device pool only
if any of the selected Bot Runner users do not have a bot running (default) device.

9. Click the right arrow (→) to add your selection.
10. Opzionale: Seleziona la Priorità di automazione dalla scheda Generale.

Imposta la priorità su alta, media o bassa in base alle tue esigenze per l'ottimizzazione delle risorse. Il
valore predefinito è media.
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11. Click Run bot now.

Nota:  If you have not set the device credentials from the My settings page, you are prompted to
provide the device credentials to run the bot.

If you encounter issues in running a bot, refer to the following articles:
• Automation 360 - Unable to download the bot or the dependencies to the device; Error code: download.error (A-

People login required).
• There is already an existing deployment in-progress for this user session (A-People login required).
• BOT stuck in In Progress Stage and not able to move it to history" or "BOT stuck in Pending execution Stage and

not able to move it to history" on Automation 360 CLOUD and On-Prem environments

Considerations for running a bot
There are certain considerations you have to keep in mind when running a bot.
• As a Bot Creator, you can deploy a bot on your device or you can run the bot on a remote machine

through RDP connection.
• If you are running bots on your local machine as a Bot Creator, enter only your username in the device

login credentials; no password is required. The username is required to confirm that the same user
who logged in to the local device is deploying the bot. If you are using the Google Chrome plug-in and
running bots on your local machine, your username is required.

• As a Bot Runner, you can either deploy the bot yourself or select a run-as user assigned by the
administrator. You can run the bot either through your device or choose from the list of devices in a
device pool. If you choose to override the default device, the bot will be executed on any available
device in the device pool for each run-as user.

• You can preload packages on your local device to shorten the bot runtime.
The system supports running only one bot for each device at a given time. If a bot is already running
on the device, you cannot deploy another bot on the device.
While a bot is running on a device, if you try to deploy another bot on the same device, the second
bot is queued according to its type. After the deployment of the currently running bot is complete, the
queued bot is automatically deployed on the same device.

• If you are running a bot from the Bot editor, closing the Control Room web browser will stop the bot
run.

• Run-as user: A set of unattended Bot Runner users that a scheduler can select from to run a bot on a
device. The run-as user can select an available device from the device pool to run the bot.

• When bots are queued for a Bot Runner user, bots with higher priority are deployed before bots with
lower priority. However, if a bot with lower priority is already running, bots with higher priority are
deployed after the bot with lower priority completes running.

• When you create the bot deployment using the Run bot now option, the bot is queued for execution.
If the bot is deleted while it is queued for execution or while it is active, an error is displayed for that
bot in the In progress activity > View activity page.

• Attended Bot Runner, Bot Creator, and Citizen Developer users can run the bots using either the Run
bot now option in the Bot editor or the shortcut key F5. However, unattended Bot Runner users can
run their bots only using the Run bot now option.

The following table explains the different scenarios where you should choose device pools against bot
running devices for the run-as user.
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Opzione Scenario Pool di
dispositivi

Default device Risultato

Information security
compliance where the
user cannot log in to any
other device

No Sì Bot deploys on the default
device of the user.

Run bot now

Specialized application
access restricted to a
user

No Sì Bot deploys on the default
device of the user.

Override bot running
device option is
selected

Sì Sì Bot deploys on the available
device in the device pool.

Override bot running
device option is not
selected

Sì Sì Bot deploys on the default
device of the user. If default
device is not available, the
bot deploys on the available
device in the device pool.

Information security
compliance where the
user cannot log in to any
other device

No Sì Bot deploys on the default
device of the user.

Schedule bot

Specialized application
access restricted to a
user

No Sì Bot deploys on the default
device of the user.

Run on bot running
devices option is
selected

Sì Sì Bot deploys on the default
device of the user.

WLM (Run bot
with queue)

Run on bot running
devices option is not
selected

Sì Sì Bot deploys on the default
device of the user. If default
device is not available, the
bot deploys on the available
device in the device pool.

AARI on the
web

Run-as user with device
pool assigned

Sì No Bot deploys on the available
device in the device pool.

Attività correlate
Add queue, Bot Runner, and device pool alla pagina 2810
Add a queue, Bot Runner, and device pool to the automation from the Run bot with queue page.

Move a bot
As a Bot Creator, you can now move your bots and files from one folder to another with ease in the private
workspace. If a bot is placed in an incorrect folder, you no longer have to clone it in the correct folder and
then delete it from the incorrect folder.
When you are moving a bot, keep the following considerations in mind:
• You can move only bots and files. You cannot move folders.
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• You can move only newly created bots and files. Checked-out, edited, and cloned bots cannot be
moved.

1. Log in to the Control Room as a Bot Creator user.
2. Select the bot or file to move. Hover over the actions menu (vertical ellipsis) located to the right of the

bot or file name and click Move Task Bot.
3. Browse and select the folder to which you want to move the bot and click Choose.

The bot is copied to the destination folder and removed from the source folder.

Nota:
• When the bot is moved, you will see a warning message to change the reference in all the parent

bots.
• You can move a folder or a sub-folder into another folder when the number of items in the folder is

less than 100. An error message is displayed if the folder contains more than 100 items (including
metadata).

Check in a bot
Check in the bot files or folders to the public workspace from private workspace to make it available for all
users who have the permission to access and run the bot.
• You must have Bot Creator or Citizen Developer license to check in a bot to the public workspace.
• You must be assigned a custom role with the following permissions:

• Required: Check in permission at the folder level and at the corresponding parent folder level in the
public workspace.

• Facoltativo: Create folder permission.
• Facoltativo: View packages permission.

• To check in a bot with dependent folders and files, ensure you have the following:
• Create folder permission.

If you are checking in a bot from your private workspace and if the folder in which the bot is present
does not yet exist in the public workspace, you must have create folder permission to successfully
check in the bot.

• Check in permission on the dependency folder.

• Ensure that your private and public workspaces have the same folder structure so that when you
check in a bot from your private workspace, it will appear in the same folder structure in the public
workspace.

• For example, if you check in a bot from the sample bot folder in the private workspace, it will appear in
the sample bot folder in the public workspace.

If you want to check in multiple bots as a unit that are not dependent on each other, create a main bot
and then add the other bots as dependencies to this main bot. Check in the main bot.
1. Accedi a Control Room come Bot Creator o utente Citizen Developer.
2. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
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3. You can choose to check in either one bot or multiple bots simultaneously.
• Select the bot that you want to check in, click the actions menu (vertical ellipsis), and click Check

in Task Bot.
• Select the bots that you want to check in and click Check in checked items.

Nota:  You can check in up to 10 bots at a time.

4. In the Check in Task Bot window, add your comment and select the dependencies you want to
check in and click Check in checked items.
The bot appears in the same folder structure in the public workspace. Le dipendenze con riferimenti
diretti vengono automaticamente sottoposte a check-in.

Nota:
• You cannot check in a bot file if another bot file already exists in the same location in the public

workspace.
• Quando si esegue l'archiviazione di un bot insieme ad un bot clonato e non vi sono altri bots che

dipendano dal clone, il bot clonato viene eliminato.

If you have issues in checking in a bot, see Unable to check-in the bots in Automation 360 (A-People login
required).

Checking out a bot and dependencies
The check out process enables you to create an editable copy of the bot in the private workspace from the
public workspace for further modification.
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After you have modified the bot, you can check in the bot again to the public workspace so that it can be
deployed by all users who have permission to access it. You can choose the specific version of the bot and
its dependencies (bot and non-bot) during the check-out process.
You can cancel the checked-out bot from your private workspace whereas an administrator can cancel the
checked-out bot from the public workspace. This releases the bot for another user who has access in the
public workspace. When you cancel check out, the bot status changes to Public in the public workspace.
In the private workspace, the status changes to New if any edits are made to the bot. Se non ci sono
modifiche, il bot viene sostituito con un clone.

Guidelines for checking out bots

While checking out a bot, keep the following considerations in mind:
• Se desideri estrarre più bots come unità che non sono dipendenti l'una dall'altra, crea un'unità

principale bot e, quindi, aggiungi gli altri bots come dipendenze a questo bot principale. Estrai il bot
principale.

• Only one user can check out a bot at a time. When a user checks out a bot, it cannot be checked out
by any other user.

• Se estrai un bot padre nello spazio di lavoro pubblico, le cui dipendenze sono state estratte da un altro
utente, le dipendenze del bot padre verranno clonate nel tuo spazio di lavoro privato.

• Se un bot è stato estratto, non può essere eliminato. The bot should be in a checked-in (Public) state
to be deleted.

• Quando modifichi un bot estratto, lo stato cambia in Estratto modificato.
Puoi utilizzare l'opzione Ripristina modifiche per ripristinare le modifiche apportate al bot estratto.

• Durante l'estrazione, un bot clonato può essere sovrascritto o sostituito.
• I file dipendenti vengono clonati automaticamente se sono stati estratti da un altro utente e si dispone

dell'autorizzazione Clona sulla cartella bot.

Prerequisites for checking out bots and dependencies

• È necessario disporre di una licenza Bot Creator o Citizen Developer per estrarre un bot nel tuo spazio
di lavoro privato.

• È necessario disporre dell'autorizzazione all'estrazione a livello di cartella.
• È necessario disporre dell'autorizzazione di estrazione per le cartelle delle dipendenze per estrarre un

bot con cartelle e file dipendenti.
• È necessario disporre delle autorizzazioni Cancella estrazione e Visualizza contenuto su uno spazio

di lavoro pubblico per cancellare o annullare un'estrazione eseguita da un utente Bot Creator,
Non è necessaria l'autorizzazione Cancella estrazione per cancellare il bot estratto da uno spazio di
lavoro privato.

Checking out bots

You can check out single or multiple bots along with their dependencies. You can also choose the version
of the bot and their dependencies during the check out.
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• Check out a single bot
• Check out multiple bots
• Check out file dependencies

Check out a single bot
Check out the specific version of a parent bot and its dependencies from the public workspace to the
private workspace to create an editable copy of the bot.
Prerequisites for checking out bot and dependencies

1. Accedi a Control Room come Bot Creator o utente Citizen Developer.
2. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
3. Select the bot, choose to either clone or check out the dependencies, open the actions menu (vertical

ellipsis) and click Check out Task Bot.

Nota:  If a bot has multiple versions, you can select and check out the specific version of the bot
using Advanced options. Questo consente di ripristinare una versione precedente del bot.

Opzione Fasi

Yes, Checkout Select this option to check out the latest version
of a bot. Le dipendenze vengono clonate
automaticamente.
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Opzione Fasi

Opzioni avanzate Select this option to select a specific version of
the parent bot and dependencies.
a. Click Advanced optoins.
b. Select the version of the parent bot to check

out.
c. Add or remove dependencies to check out.
d. Select the version of the dependency (bot or

non-bot) to check out.
e. Review the dependencies (Overwritten,

Missing, Cloned, Skipped).
f. Clicca su Estrai.

The bot appears in the same folder structure in the private workspace. When you check out bot files
or folders, all the dependencies linked to the bot files or folders will either be checked out or cloned
according to your choice.

4. Per annullare l'estrazione di un bot, fai clic sull'opzione Annulla l'estrazione di Task Bot.
Puoi utilizzare questa opzione dallo spazio di lavoro pubblico o privato.
In the public workspace, the bot status changes to public, and the bot is available for check out by
another user with the appropriate permissions.
In the private workspace, the bot status changes to new if any changes are made to the bot. Se non
ci sono modifiche, il bot viene sostituito con un clone.

Check out multiple bots
Check out the specific versions of the parent bots and its dependencies from the public workspace to the
private workspace to create an editable copy of the bot.
Ensure you have completed all the prequisites for checking out bots:
• Prerequisites for checking out bot and dependencies
• Check out up to 10 parent bots at a time
• Check out only the latest version of the bot

1. Accedi a Control Room come Bot Creator o utente Citizen Developer.
2. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei bots disponibili.
3. Select the bots you want to check out and from the table level icons, click Check out checked

items.

Nota:  You can check out up to 10 parent bots at a time. You can check out only the latest version of
the bot and its dependencies.

Opzione Fasi

Estrai Select this option to check out the latest version of a bot. Le dipendenze
vengono clonate automaticamente.
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Opzione Fasi

Opzioni avanzate Select this option to review the information about the bot and
dependencies which can be checked out, skipped, cloned and click Check
out.
• The Files tab displays the bot files that can be checked out.
• The Checkout Dependencies tab displays the dependencies which

you can choose to check out.
• The Review dependencies tab displays the information on the

dependencies which are Overwritten, Missing, Cloned, or Skipped.

The bot appears in the same folder structure in the private workspace. When you check out bot files
or folders, all the dependencies linked to the bot files or folders will either be checked out, cloned,
skipped, or overwritten. Per ulteriori informazioni, consulta Considerations for checking out multiple bots
alla pagina 2002.

Considerations for checking out multiple bots
There are certain considerations you have to keep in mind when checking out multiple bots.
• You can check out up to 10 parent bots at a time.
• You can only check out the latest version of the bot. You cannot select a specific version of the bot to

check out.
• During check out of multiple bots, the parent bots and their dependencies are either checked out,

cloned, skipped, or overwritten depending on different scenarios.

The following table explains the different scenarios of the parent bots and their dependency behavior
during check out of multiple bots.

Scenario Behavior

Parent bot not checked out by the
current user

The parent bot is checked out as part of the bulk checkout
and is shown in the check-out section of the basic flow.

Dependency not checked out by the
current user

The dependency is checked out as part of the bulk check out
and is shown in the check-out dependencies section of the
advanced flow.

Parent bot is already checked out by
the current user

The parent bot is not re-checked out and is shown in the
skipped section of the basic flow.

Dependency already checked out by
the current user

The dependency is not re-checked out and is shown in the
skipped section of the advanced flow.

Dependency checked out by other
users

The dependency is cloned during bulk check out.

Parent bot already cloned by the
current user and requiring a check
out

The parent bot is checked out as part of the bulk checkout,
and the clone will be replaced with the checked out bot.

Dependency already cloned by the
current user and requiring a check
out

The dependency is checked out as part of the bulk checkout,
and the clone will be replaced with the checked out bot.

Dependency already cloned by the
current user and is shown again for
cloning in bulk check out

The dependency is not re-cloned and is shown in the skipped
section of the advanced flow.
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Scenario Behavior

Parent bot is in new status in private
workspace

During bulk check-out, the user is provided an option to
overwrite the bot in the basic flow.

Dependency is in new status in the
private workspace

If the dependency is to be checked out, it is shown in the
overwrite section of the advanced flow. If the dependency
is to be cloned, it is shown in the cloned section of the
advanced flow.

Clone a bot
Create a read-only copy of the bot from the public workspace to the private workspace so that you can
have a local copy without checking out the bot.
• Create a user with a Bot Creator license.
• Create a custom role with the clone permission assigned at the folder level to the user.
• To clone a dependency folder, you must have the clone permission on the dependency folder.

Cloning a bot does not affect other users' access to the bot in the public workspace. A bot can be cloned
by multiple users.
1. Log in to the Control Room as a Bot Creator user.
2. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
3. Select the bot you want to clone, click the actions menu (vertical ellipsis), and click Clone Task Bot.

The cloned bot appears in the same folder structure in the private workspace.

Eliminare un bot
If you are a Control Room administrator or user with Delete from Public permission, you can delete bots
from the public workspace. If you are a Bot Creator, you can delete bots from your private workspace.
To delete a bot, ensure the following:
• Public workspace: You must have the Control Room administrator role or the Delete from Public

permission at the folder level.
• Dependent folders and files: You must have the Delete from Public permission on these folders

and files.
• Private workspace: È necessario disporre di una licenza Bot Creator.

You cannot restore a deleted bot, so ensure that you no longer require a bot before deleting it.

Nota:  After you delete a bot, if you immediately create a bot with the same name as the deleted bot and
create it in the same folder, an error is displayed in some cases. To avoid this error, after you delete a bot,
wait for at least 5 seconds for the deletion to be completed. You can create another bot with the same
name as the deleted bot and in the same folder.
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• Delete bots from a private workspace:
In a private workspace, you can delete only bots that are in the New or Cloned status. You cannot
delete a bot in the Checked out or Checked out and edited status.
a) Log in to the Control Room as a Bot Creator.
b) Nel pannello di sinistra, fai clic su Automazione.

A list is displayed with the available files and folders containing the bots.
c) From the Automation page, choose one of the following methods to delete a bot:

Opzione Azione

Specific bot a. Select the bot.
b. Hover over the actions menu (vertical ellipsis) located to

the right of the bot name and click Delete Task Bot.
c. Click Yes, delete.

Multiple bots a. Select the check boxes corresponding to the bots, and
click Delete checked items.

b. Click Yes, delete.

• Delete bots from a public workspace:
In the public workspace, you can delete only bots that are in the Public status. You cannot delete bots
that are in the Checked out status.
a) Log in to the Control Room as an administrator, a Bot Creator, or an attended or unattended Bot

Runner user with Delete from Public permission.
b) Nel pannello di sinistra, fai clic su Automazione.

A list is displayed, with the available files and folders containing the bots.
c) From the Automation page, choose one of following methods to delete a bot:

Opzione Azione

Specific bot a. Select the bot.
b. Hover over the actions menu (vertical ellipsis) located to

the right of the bot name and click Delete Task Bot.
c. Click Yes, delete.

Multiple bots a. Select the check boxes corresponding to the bots, and
click Delete checked items.

b. Click Yes, delete.

Preload packages
You can preload packages on your local device to shorten the bot runtime.
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When you run a bot, the system downloads the bot and all the packages used in the bot. Bot execution
begins when the download is complete. If the packages used in the bot are preloaded, the system can skip
downloading the packages and start executing the bot, thereby reducing the bot execution timeframe.
Folder path: Preloaded packages are stored in \ProgramData\AutomationAnywhere\GlobalCache
on the local device.
If there are multiple versions of a package, only the default package is preloaded. You can only preload
packages on your local device. For the option to be available, the automatically download preloaded
packages setting must be enabled by the Control Room admin.

Nota:  You can also save specific versions of packages that are used in bots offline to save the time it
takes to download these packages from the Control Room. The specific version of packages are stored in
the C:\ProgramData\AutomationAnywhere\AAPreloadedPackages folder.

Perform the following steps to preload packages on your local device:
1. Log in with a Bot Creator account.
2. Click the Manage > Devices > Preload package icon in the menu list for your local device.

Nota:  The Preload package option is also available from the device icon drop-down menu for
Automation 360 Cloud through the Google Chrome browser with the Chrome plug-in enabled.

3. In the Preload packages window, preload either all packages listed on the Common packages
page, or select individual packages from the Customize packages page.
Common packages are the most lightweight and most commonly used ones.

4. Click the Start preloading option.

Copy a bot
Copy a bot to create a duplicate sequence of actions within your private repository. The copy retains the
meta-data of the original bot including captured images, recorded objects, called files, and child bots.
To copy a bot, follow these steps:
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Mouse over the actions menu.

The actions menu is the vertical stack of three dots to the left of each bot.
3. Click the Copy Task Bot icon.
4. In the Name field, enter a name for the duplicate bot.

Importante:  Bot name must be unique. If a bot with the same name exists in the same folder
location which you have access to in the public workspace, you will not be able to copy the bot with
this name in the private workspace.

5. Opzionale: Click Browse to select the folder where to save the bot.
6. Click Copy.

The duplicate bot appears in the specified folder.

Visualizzare la cronologia delle versioni di TaskBot
Visualizza la cronologia delle modifiche apportate ai TaskBots. È possibile identificare le azioni eseguite da
un utente in una data e un orario specifici insieme ai messaggi di archiviazione.
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You must have either check-in or check-out permissions.
È possibile visualizzare la cronologia delle versioni dei TaskBots disponibile nell'area di lavoro pubblica e
nell'area di lavoro privata (solo se sono presenti bots estratti). Tuttavia, non è disponibile alcuna cronologia
delle versioni per TaskBots nuovi e clonati.
The check-in or the check-out permission is required for the Bot Runner to view the version history.
However, note that this permission cannot be used by the Bot Runner to check in or check out bots.
1. Accedi a Control Room.
2. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
3. Visualizza la cronologia delle versioni di TaskBots nei seguenti modi:

• Seleziona i TaskBots per cui desideri visualizzare la cronologia delle versioni. Passa il mouse
sul menu azioni (puntini di sospensione verticali) a destra del nome dei TaskBots e fai clic su
Visualizza cronologia TaskBot.

• Click the bot name. Quando il bot si apre, fai clic sui puntini di sospensione verticali nell'angolo in
alto a destra e seleziona l'opzione Visualizza cronologia TaskBot.

Viene visualizzato un messaggio che elenca tutte le versioni del bot selezionato in una sequenza (la
revisione più recente in alto e la prima revisione alla fine). Le informazioni includono il numero della
versione, il messaggio di archiviazione, la data e l'ora di archiviazione e il nome dell'utente che ha
eseguito l'archiviazione.

Assign label to a bot
You can now assign a production label for a particular version of a bot. You can use this label to
choose the version on which you want to perform certain bot operations. Con la versione scelta, puoi
programmare, eseguire, mettere in coda, esportare e attivare flussi di lavoro di sviluppo bot.
• You must have a custom role with the Label bots permission.
• You can apply labels only to the bots that are checked in to the public workspace.

1. Accedi a Control Room.
2. On the left panel in the public workspace, click Automation.

Viene visualizzato un elenco dei moduli e dei bots disponibili.
3. Select a bot, hover over the Actions menu (vertical ellipsis) on the right of the bot name, and click

Label Task Bot.
A list of available versions of the bot is displayed.

4. Select the version of the bot to which you want to apply a label.
5. Click the right arrow (→) to add your selection.
6. Click Apply Label.

The label Production is now assigned to the bot.

Nota:  Se l'opzione etichetta di produzione è selezionata per il bot padre, vengono selezionati
automaticamente anche i corrispondenti bots dipendenti con l'etichetta di produzione. Se uno qualsiasi
dei bots dipendenti non ha l'etichetta di produzione applicata, viene selezionata la versione più
aggiornata del bot. However, if the dependent bot is called through Task Bot > Run > Variable >
Control Room path option, always the latest version of the bot is selected even if the production
label is applied to the bot.
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Modifica di un bot
Edit bot logic using the Bot editor to add, modify, or delete actions and automation steps.

Open a bot

Open a bot in the Bot editor in one of the following ways:
• Select the bot and click Edit. The edit button is a pencil icon.
• Right-click on the bot and select Edit.
• Click Actions and select Edit.

Compare bot versions
You can compare different versions of your bots and view any modifications in your workflows in both the
public and the private workspaces.
Ensure you have the following permissions:
• View my bots
• View content
• Check in or Check out

• Public workspace
a) Accedi a Control Room come Bot Creator o utente Citizen Developer.
b) Navigate to the public workspace.
c) Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei bots disponibili.
d) Select a bot, hover over the actions menu (vertical ellipsis) on the right of the bot name, and click

Compare versions.
The compare version page appears with two versions of your bot. The left column shows the
previous version of your bot, and the right column shows the newer version of your bot.

e) Click the Change version icon to select and confirm the version of the bot that you want to
compare on the left and right column.
You can review the two versions of your bot. The red highlights on the left column show the lines
that are modified. The green or blue highlights on the right column show the lines that are added
or changed. This view shows the bot versions by Actions.

Nota:  When you compare two versions of a bot, you might sometimes not observe any visible
changes. This is because the bot version is modified as a result of changes in the underlying JSON
file.

f) Opzionale: Select Variables, Triggers, Packages, or Dependencies to compare your bot
versions by these categories.

Nota:  The changes made to the immediate dependencies are displayed, and the dependencies
are sorted in an alphabetical order.

g) Opzionale: Select the Swap versions icon to swap between your two current versions.
h) Click Close to exit the comparison view.
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• Private workspace
a) Accedi a Control Room come Bot Creator o utente Citizen Developer.
b) Navigate to the private workspace.
c) Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei bots disponibili.
d) Select a bot, hover over the actions menu (vertical ellipsis) on the right of the bot name, and click

Compare versions.
The compare version page appears with the left column displaying the source checked-out version
of the bot in the public workspace and the right column displaying the checked-out and edited bot
in the private workspace.

e) Click Change version to change the current bot version in the left column (Public version).
The Select version to compare page prompts you to select a new bot version.

Nota:  You cannot change version on the right column (Private version).

f) Select and confirm the version of the bot that you want to compare on the left column.
You can review the source and edited versions of your bot . The red highlights on the left column
show the lines that are modified. The green or blue highlights on the right column show the lines
that are added or changed. This view shows the bot versions by Actions.

g) Opzionale: Select Variables, Triggers, Packages, or Dependencies to compare your bot
versions by these categories.

Nota:  The changes made to the immediate dependencies are displayed, and the dependencies
are sorted in an alphabetical order.

h) Click Close to exit the comparison view.

View bot dependency map
Ora puoi visualizzare la mappa delle dipendenze per il tuo bot sia nell'area di lavoro pubblica che in quella
privata. La mappa delle dipendenze mostra i bots padre e figlio immediati per ogni bot selezionato. Grazie
a queste informazioni, puoi valutare l'impatto della variazione di un bot, utilizzare in modo efficace il bot,
garantire un codice e una capacità di riutilizzo del bot migliori e prevenire i conflitti.
Ensure that you have the View content permission.

1. Accedi a Control Room.
2. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei bots disponibili.
3. View the dependency map of the bots in the following ways:

• Seleziona i bot per cui desideri visualizzare la cronologia delle versioni. Hover over the actions
menu (vertical ellipsis) located to the right of the bot name and click View dependencies and
references.

• Click the bot name. When the bot opens, click the vertical ellipsis at the top-right corner and select
View dependencies and references.
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4. Toggle between the Dependencies and References tabs to view the immediate parent and child
bots.
• Dependencies: Displays the bots or files that the bot uses to run
• References: Displays the bots or files that depend on the bot to run

Attach work item template to TaskBot
Attach a work item template to a TaskBot to use the TaskBot in workload automation.
When you attach a work item template to a TaskBot, you can use the variable $WorkItem$ that contains
the attributes for the required workload automation when you run the bot using the Run bot with queue
option.
Use Work Item variables alla pagina 2038
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Create or edit a TaskBot from the Automation page.

The TaskBot opens in edit mode.
3. Select the option Work item template from the menu at the top-right of the Workbench.

The list of Work item templates appears.
4. Select the template that best suits your workload automation requirement.
5. Click the right arrow to add the template.

The Work item template attributes are listed for the selected template.
6. Fai clic su Salva.
7. Choose one of the following actions:

• Click Close to return to the My bots page.
• Click Return to editor to continue editing the TaskBot.

Concetti correlati
Gestione del carico di lavoro alla pagina 2797
Il modulo di gestione del carico di lavoro consente agli utenti di caricare file in formato Microsoft Excel e
CSV nella Control Room in modo che questa possa inserire i record dai file nelle distribuzioni dei bot.
Attività correlate
Use Work Item variables alla pagina 2038
You can use the Work Item variables to pass the Work Item attributes or values to the TaskBot from the
Control Room when you run the bot with the option Run bot with queue.
Riferimenti correlati
Workload package alla pagina 1937
The Workload package enables you to insert work items in a queue for workload automation. It also
enables data chaining between multiple queues. You can orchestrate multiple bots, and enable optimal
device utilization through the queueing mechanism of workload management.

View package versions available in the Control Room
Actions are grouped into version-specific packages. Bot Creators can select which package version to use
for a specific bot.
Gli utenti di base possono visualizzare solo i pacchetti disponibili in Control Room e i dettagli specifici del
pacchetto.
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I Bot Creators richiedono l'autorizzazione AAE_Basic per selezionare pacchetti specifici da utilizzare
all'interno di un bot.
Go to the Manage > Packages page to view all the packages in the Control Room.

Packages updated in Automation 360 v.26

Importante:
• For information about packages updated in v.27, see Packages updated in v.27 alla pagina 129
• For information about packages in releases previous to v.26, see the PDFs for these releases: Versioni

precedentemente rilasciate di Automation 360.

The following table provides details about the updates in the packages for v.26:

Nome
Package

Versione Aggiornamenti
Package

Versione Bot Agent Versione Control Room

AARI web 7.0.1-20220727-162102 Nessuno 21.134 or later 12316 or later

Active
Directory

3.5.0-20220416-233339 Nessuno 20.11 or later 8750 or later

Analizza 2.4.4-20220615-020937 Nessuno 20.11 or later 8750 or later

App
Integration

4.8.0-20220616-123118 Defect fix 21.88 or later 10195 or later

Application 3.5.0-20220416-233350 Nessuno 20.11 or later 8750 or later

Boolean 2.5.0-20220118-153154 Nessuno 20.11 or later 8750 or later

Migrazione
di Bot

9.1.9-20220902-133838 • New
feature 1

• New
feature 2

• New
feature 3

• New
feature 4

• New
feature 5

• Defect
fix 1

• Defect
fix 2

• Defect
fix 3

21.220 or later 15224 or later

Browser 3.6.1-20220802-062805 Defect fix 21.210 or later 14140 or later

Clipboard 3.4.0-20220416-233509 Nessuno 20.11 or later 8750 or later

Comment 2.11.0-20220419-061753Nessuno 20.11 or later 8750 or later

Credenziale 1.3.0-20220416-233509 Nessuno 20.11 or later 8750 or later
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Nome
Package

Versione Aggiornamenti
Package

Versione Bot Agent Versione Control Room

CSV/TXT 2.9.0-20220419-061754 Nessuno 20.11 or later 8750 or later

Database 4.9.3-20220804-174704 • Defect
fix 1

• Defect
fix 2

21.88 or later 10204 or later

Data Table 4.5.1-20220509-073253 Nessuno 20.11 or later 8750 or later

Datetime 2.8.8-20220628-071423 Defect fix 20.11 or later 8750 or later

Delay 3.5.0-20220416-233521 Nessuno 20.11 or later 8750 or later

Dictionary 3.8.0-20220505-214608 Nessuno 20.11 or later 8750 or later

DLL 6.6.1-20220617-052638 • Enhancement
• Defect

fix

21.200 or later 15238 or later

Document
Extraction

1.0.6-20221207-201734 Nessuno 21.98 or later 15345 or later

Email 3.13.1-20220713-173156• New
feature

• Defect
fix 1

• Defect
fix 2

• Defect
fix 3

21.210 or later 13980 or later

Trigger di
e-mail

2.7.3-20220714-073535 Defect fix* 21.210 or later 13980 or later

Error
handler

2.9.0-20220127-062650 Nessuno 20.11 or later 8750 or later

Excel
advanced

6.10.4-20220714-144826• New
feature 1

• New
feature 2

• Defect
fix 1

• Defect
fix 2

21.112 or later 11307 or later

Excel basic 6.10.3-20220630-102036Defect fix* 21.112 or later 11307 or later

File 6.4.0-20220615-171851 Defect fix 21.98 or later 10789 or later

File e
cartella

1.2.0-20220628-195259 Nessuno 20.11 or later 8750 or later

Folder 6.4.0-20220615-171851 Defect fix 20.11 or later 8750 or later
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Nome
Package

Versione Aggiornamenti
Package

Versione Bot Agent Versione Control Room

FTP / SFTP 2.8.1-20220530-074610 • Defect
fix 1

• Defect
fix 2

20.11 or later 8750 or later

Genesys 1.0.4 Nessuno 21.210 or later 14199 or later

Google
Calendar

2.8.1-20220623-122146 Defect fix* 20.11 or later 8750 or later

Google
Drive

2.8.1-20220623-094335 Defect fix* 20.11 or later 8750 or later

Google
Document
AI

1.2.0-20220616-091303 Defect fix* 21.98 or later 10520 or later

Google
Sheets

2.9.2-20220628-052504 Defect fix* 20.11 or later 8750 or later

Google G
Suite

2.8.0-20220416-235104 Nessuno 20.11 or later 8750 or later

Hot key 1.1.0-20220715-220729 Nessuno Nessuno Nessuno

If 3.4.0-20220127-062702 Nessuno 20.11 or later 8750 or later

Image
Recognition

3.11.0-20220623-052117Defect fix* 21.210 or later 14100 or later

Moduli
interattivi

2.26.2-20220728-053945• New
feature

• Defect
fix

20.11 or later 8750 or later

Interface
trigger

1.5.0-20220812-185225 Nessuno 20.11 or later 8750 or later

IQ Bot 2.2.5-20221107-102303 Nessuno 21.98 or later 10520 or later

IQ Bot
Pre-
processor

2.2.5-20221107-101937 Nessuno 21.98 or later 10520 or later

JavaScript 2.13.0-20220620-094839Defect fix* 20.11 or later 8750 or later

JSON 1.1.0-20220419-055641 Nessuno 21.98 or later 10520 or later

Legacy
AISense

1.0.8-20220714-195459 • Defect
fix 1

• Defect
fix 2

21.220 or later 15224 or later

Legacy
Automation

5.3.1-20220804-175600 Defect fix 21.200 or later 13279 or later

List 2.8.0-20220118-153952 Nessuno 20.11 or later 8750 or later
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Nome
Package

Versione Aggiornamenti
Package

Versione Bot Agent Versione Control Room

Log To File 3.5.0-20220416-233918 Nessuno 20.11 or later 8750 or later

Loop 3.5.0-20220416-233919 Nessuno 20.11 or later 8750 or later

Message
Box

3.4.0-20220416-233919 Nessuno 20.11 or later 8750 or later

Mouse 2.12.3-20220616-131218Defect fix* 21.210 or later 14100 or later

Number 3.5.0-20220416-233938 Nessuno 20.18 or later 9130 or later

OCR 2.10.0-20220502-204318Nessuno 21.118 or later 8750 or later

Office 365
Calendar

2.8.1-20220516-181356 Nessuno 20.11 or later 8750 or later

Office 365
Excel

2.9.1-20220516-182121 Nessuno 20.11 or later 8750 or later

Office 365
OneDrive

2.8.1-20220516-182128 Nessuno 20.11 or later 8750 or later

PDF 3.6.0-20220616-054613 • Defect
fix 1

• Defect
fix 2

21.31or later 9300 or later

PGP 3.4.0-20220118-154220 Nessuno 21.88 or later 10195 or later

Ping 3.4.0-20220416-234250 Nessuno 20.11 or later 8750 or later

Play Sound 2.6.0-20220421-071315 Nessuno 20.11 or later 8750 or later

Printer 2.4.0-20220118-154256 Nessuno 20.11 or later 8750 or later

Trigger di
processo

1.3.0-20220118-154818 Nessuno 21.112 or later 11314 or later

Process
Discovery

2.1.13-20220712-150821Nessuno 21.128 or later 12247 or later

Prompt 2.6.0-20220118-154257 Nessuno 20.11 or later 8750 or later

Python
Script

2.12.0-20220812-184521Nessuno 20.11 or later 8750 or later

Registra 1.5.0-20220505-215415 Nessuno 20.11 or later 8750 or later
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Nome
Package

Versione Aggiornamenti
Package

Versione Bot Agent Versione Control Room

Recorder 2.8.6-20220823-160834 • New
feature 1

• New
feature 2

• Defect
fix 1

• Defect
fix 2

• Defect
fix 3

• Defect
fix 4

• Defect
fix 5

• Defect
fix 6

• Defect
fix 7

21.210 or later 14068 or later

REST Web
Service

3.11.1-20220714-082239• New
feature 1

• New
feature 2

• Defect
fix

20.11 or later 8750 or later

Salesforce 1.0.2-20220725-133902 New feature 21.119 or later 15422 or later

SAP 3.7.1-20220616-055414 New feature 21.88 or later 10195 or later

SAP BAPI 2.7.0-20220424-053247 Nessuno 21.2 or later 9249 or later

Screen 2.8.0-20220426-033753 Nessuno 20.11 or later 8750 or later

Servizio 4.5.0-20220416-234715 Nessuno 20.11 or later 8750 or later

Trigger di
servizio

1.5.1-20220425-083711 Nessuno 21.112 or later 11314 or later

Simulate
keystrokes

3.9.2-20220620-185233 Defect fix* 21.200 or later 13297 or later

SNMP 2.5.0-20220419-063009 Nessuno 20.11 or later 8750 or later

SOAP Web
Service

3.12.1-20220715-125139• New
feature

• Defect
fix*

21.90 or later 10227 or later

Step 2.3.0-20220715-220724 Nessuno 20.11 or later 8750 or later

String 5.4.2-20220412-134724 Nessuno 20.18 or later 9130 or later

System 3.9.2-20220421-100102 Nessuno 21.88 or later 10217 or later
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Nome
Package

Versione Aggiornamenti
Package

Versione Bot Agent Versione Control Room

Task Bot 2.4.0-20220628-195240 Nessuno 20.11 or later 8750 or later

Terminal
Emulator

4.7.1-20220728-125827 • New
feature

• Defect
fix 1

• Defect
fix 2

21.93 or later 10353 or later

Text file 1.3.0-20220416-235037 Nessuno 20.11 or later 8750 or later

Attiva loop 0.7.0-20220715-220725 Nessuno 20.11 or later 8750 or later

Task Bot
V11

1.12.1-20220707-062607Defect fix 20.11 or later 8750 or later

VBScript 2.16.0-20220628-195244Defect fix* 21.210 or later 14100 or later

Wait 4.5.0-20220416-235041 Nessuno 20.11 or later 8750 or later

Window 5.7.1-20220804-040754 • New
feature

• Defect
fix 1

• Defect
fix 2

20.11 or later 8750 or later

Trigger
Window

1.4.0-20220118-154823 Nessuno 20.11 or later 11314 or later

Workload 2.10.1-20220512-164301Nessuno 20.11 or later 8750 or later

XML 3.6.0-20220530-054638 Defect fix* 20.11 or later 8750 or later

* These fixes do not include information in our documentation site, so no links are provided.

Select the package version used in your bot
As a Bot Creator you have the ability to select which package version to use for a set of actions within your
bot.
You need to have AAE_Basic permission.

Suggerimento:  For existing bots, follow these steps to update to the default package.

1. Open or create a new bot from Automation page.
2. Click the vertical ellipses in the upper right corner, and select Packages.

Nota:  The packages used in the selected bot are highlighted.

3. Click the drop-down list to view which version of the package is currently used for this bot.
4. To change the package version to be used for this bot, select the package version to use from the

drop-down list of available packages.
5. Click Change version.
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6. Fai clic su Salva.

Versione di compatibilità di Bot
Bot compatibility version provides internal versioning for bot compilation and helps track different runtime
behaviors for specific features. Compatibility version helps to maintain backward-compatibility when there
are breaking changes (when you make changes in one part of the code that can cause potential issues in
other areas).

Available compatibility versions

Bot compilation occurs on the device where the Control Room is located. Typically a Windows or Linux
device is used based on the deployment model (Windows for On-Premises and Linux for Cloud).
Depending on your requirements, choose one of the following versions:

Versione Descrizione

1 The bot file path is parsed at compilation time

2 The bot file path is parsed at bot runtime depending on the device on which
the bot is running
For example, the UNC (universal naming convention) path format is different
for Windows and Linux. When you choose this version, a message is sent to
the bot compiler to parse the file path during runtime instead of at compilation
time.

3
(Default)

The global value used in the parent bot is carried over to the child bot using a
shared cache for the entire bot run which recduces the bot execution time.

Set the bot compatibility version

As a Bot Creator, you can set the bot compatibility version in the private workspace.
1. Accedi a Control Room.
2. In the private workspace, select the bot for which you want to set the version.

The bot opens in edit mode.
3. From the actions menu (vertical ellipsis), select Advanced settings.
4. If the Bot compatibility version is set to 1 or 2, we recommend that you set it to 3 (default

version) to enhance performance when using global values. Ensure that the parent bot and all the
child bots have the Bot compatibility version set to 3.

Nota:  If you set the Bot compatibility version to 1, the bot runtime might be impacted; and if
you set it to 2, then the bot execution time might increase when using global values across bots.

5. Facoltativo: Select the Enabled improved number support check box in the Advanced
features field.
This setting helps in accurate float number calculation (positive or negative whole number with a
decimal point) for your new bots.
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6. Torna all'editor dei bot e salva il bot.

Compatibility version for migrated bots

After migration from Enterprise 11 to Automation 360 and if you have removed the AAApplicationPath
from the destination path, your bot might fail. For more information on how to resolve this issue, see
Migrated bots and compatibility versions.

Impostare la priorità di automazione per i bots
Imposta la priorità di automazione dei tuoi bots su alta, media o bassa in modo che le automazioni
con priorità più alta vengano elaborate per prime per la distribuzione. Ciò consente di rispettare gli SLA
(Service Level Agreement) aziendali per l'ottimizzazione delle risorse.

• È necessario disporre di una licenza Bot Creator.
• You must be assigned the Set automation priority to high permission.

È possibile impostare la priorità di automazione quando si crea e si modifica un bot.
1. Log in to the Control Room as a Bot Creator user.
2. Nell'area di lavoro privata, seleziona un bot per il quale si desidera impostare la priorità.

Il bot viene aperto in modalità modifica.
3. From the actions menu (vertical ellipsis), select Advanced settings.
4. Imposta Priorità di automazione su alta, media o bassa in base alle tue esigenze.

When bots are queued for a Bot Runner user, bots with higher priority are deployed before bots with
lower priority. However, if a bot with lower priority is already running, bots with higher priority are
deployed after the bot with lower priority completes running.
Il valore predefinito è media.

5. Torna all'editor dei bot e salva il bot.

Configurare il timeout per l'esecuzione di bot
Specifica la quantità di tempo che il sistema deve attendere prima di terminare un bot che non risponde o
che sta impiegando più tempo del previsto per completare l'attività.
Se si verifica il timeout di un'attività, tutte le attività a valle (in una coda) possono essere eseguite senza
problemi.
Il timeout di un'attività non è applicabile nei seguenti scenari:
• Quando un'attività viene messa in pausa manualmente.
• Se l'attività viene eseguita in modalità Debug.
• Se l'attività è chiamata attraverso l'action Esegui del package Task Bot.
• Quando la prima attività di un processo viene messa in pausa, vengono annullate altre attività e viene

ripresa la prima attività.

1. Accedi a Control Room.
2. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
3. Apri il bot per il quale desideri impostare il timeout.
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4. Seleziona Impostazioni avanzate dal menu delle azioni (tre puntini di sospensione verticali) in alto
a destra.

5. Nel campo Timeout, specifica la quantità di tempo che desideri che il sistema attenda prima di
annullare un bot.
Per impostazione predefinita, il valore nel campo Timeout è impostato a zero (0) e il sistema aspetta
fino a quando il bot completa l'esecuzione.

6. Ritorna all'Bot editor e salva le modifiche nel bot.

Crea e rinomina le cartelle
Depending on the permission assigned to you, you can create or rename folder names and description in
the private workspace and rename the folder description in the public workspace. This helps to organize
your bots and files in the Control Room repository.
Per creare cartelle, devi disporre delle autorizzazioni seguenti:
• Visualizza i miei bots
• Crea cartelle

Per rinominare le cartelle, devi disporre delle autorizzazioni seguenti:
• Visualizza i miei bots
• Rinomina cartelle

You can grant access privileges to other users to specific folders so that they can perform various bot
operations on the bots contained in that folder. Durante la ridenominazione della cartella, tieni presente le
seguenti considerazioni:
• Puoi rinominare le cartelle non vuote solo nell'area di lavoro privata.
• Quando rinomini una cartella, accertarti di quanto segue:

• Non deve contenere bots estratti o clonati, anche a livello di sottocartelle.
• Non deve contenere più di 100 elementi, comprese le sottocartelle e i file.

• Crea una cartella
a) Naviga su Automazione > Cartella.
b) Fai clic su una cartella nella visualizzazione ad albero Cartelle per aprirla. Ad esempio, Bot > Bot

di esempio.
c) Fai clic sull'icona per creare sottocartelle nella scheda Cartella e assegna un nome appropriato.
d) Sfogliare e selezionare il percorso in cui salvare la cartella.
e) Fai clic su Crea cartella.

La cartella viene aggiunta e può essere visualizzata nella visualizzazione ad albero Cartelle e nella
scheda File e cartelle.
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• Rename a folder in the private workspace
a) Naviga su Automazione > Cartella.
b) Fai clic su una cartella nella visualizzazione ad albero Cartelle per aprirla. Ad esempio, Bot > Bot

di esempio.
c) Nella scheda File e cartelle, passa il mouse sulla cartella che desideri rinominare e fai clic su

Modifica cartella (icona matita).
d) Provide an appropriate name and description and browse and choose the path to the location

where you want to save the folder.
e) Fai clic su Salva modifiche.

• Edit folder description in the public workspace
a) Naviga su Automazione > Cartella.
b) Fai clic su una cartella nella visualizzazione ad albero Cartelle per aprirla. Ad esempio, Bot > Bot

di esempio.
c) Nella scheda File e cartelle, passa il mouse sulla cartella che desideri rinominare e fai clic su

Modifica cartella (icona matita).
d) Enter a meaningful description and then browse to select the location where you want to save the

folder.
e) Fai clic su Salva modifiche.

Keyboard shortcuts
List of keyboard shortcuts supported.

All modes - Flow or List view

In the Bot editor, you can open a menu to display available keyboard shortcuts.
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Keys Azione

Esc Closes node details or clear cursor

Tabulazione Toggles Flow or List view

Invio Shows node details and focus first input

Spazio Toggles node details

Ctrl A Selects all nodes

All modes - Flow view

Keys Azione

Su Moves cursor up

Giù Moves cursor down

Sinistra Moves cursor left

Destra Moves cursor right

All modes - List view

Keys Azione

Su Moves cursor up

Giù Moves cursor down
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Edit mode

Keys Azione

Ctrl S Saves file

F5 Esegui

F10 Enters debug mode

Shift F9 Toggles all breakpoint

Edit modes - Flow or List view in focus

Keys Azione

Ctrl Shift R Starts recording

Ctrl / Enables or disables mode

F9 Toggles node breakpoint

Ctrl C Copy node

Ctrl X Cut node

Ctrl V Paste node

Elimina Elimina nodo

Ctrl Z Annulla

Ctrl Y Ripeti

Debug mode

Keys Azione

F5 Play/pause/restart

F6 Step next

F7 Sospendi

F10 Exits debug mode

Shift F9 Toggles all breakpoints

Debug mode - Flow or List view in focus

Keys Azione

F9 Toggles node breakpoints
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Node details

Keys Azione

Ctrl Enter Accepts current input and saves the action or trigger

Variables overview
Automation 360 offers a variety of variables, each designed to hold specific types of data and is intended
for specific use. Use the topics below to learn more about each variable and how to use them.

Using variables

The following table describes how Automation 360 passes variable values between a parent and child bot
when using different data types:

Tipo di dati Esempio Behavior

Primitive data type (stores a
single value)

String, Number, or Boolean You create a parent and a child
bot using primitive data types
and run the TaskBot. When the
parent bot passes a variable
to the child bot through input
variables, and if you change the
values of those variables in the
child bot, the changes are not
saved when execution returns
to the parent bot. When you
use primitive data types, the
variable's actual value is passed,
and any changes made to these
variables in the child bot are not
reflected in the parent bot.

Non-Primitive data type (stores
multiple values)

List, Dictionary, or Record You create a parent and child
bot using non-primitive data
types and run the TaskBot.
When the parent bot passes
a variable to the child bot
through input variables, and
if you change the values of
those variables in the child bot,
the changes are saved when
execution returns to the parent
bot. When you use the non-
primitive data types, the values
are passed by reference, and
any changes made to these
variables in the child bot are
reflected in the parent bot.

Esempio: You created a parent and child bot using the following variables:
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• VarList: Employee data (First name, last name, Date of birth)
• VarString: Employment type (Permanent)
• VarNumber: 100

You used the same variables in the child bot with the Use as input check box selected.
In the child bot, you updated the following values:
• Added a new detail in the VarList variable as Employee data (Date of Joining)
• Changed the value of the VarString variable to Employment type (Contract)
• Changed the value of the VarNumber variable to 50

When the parent bot calls the child bot, and the execution returns to the parent bot, the List variable will
show the updated values, whereas the String and Number variable values will not change:
• VarList: Employee data (First name, Last name, Date of birth, Date of joining)
• VarString: Employment type (Permanent)
• VarNumber: 100

Credentials and credential variables in the Bot editor
alla pagina 2039

Use credentials when building bots to pass sensitive
information such as passwords and account
numbers. Using credentials separates the sensitive
information from the bots and Bot Runners, which
reduces the risk of data spillage or unauthorized
user access.

Variabili predefinite alla pagina 2023 Predefined (or system) variables return the
specific values about the machine on which the
bot is executed. Users cannot edit the values of a
predefined variable.

Le tue variabili (definite dall'utente) alla pagina
2026

Gli utenti e alcune actions creano variabili definite
dall'utente per conservare temporaneamente dei
valori. Use this kind of variable to input values into
an action (window title, login credential, or file
path) or to accept the output of an action (values
read from a file or a Boolean return).
Create a variable alla pagina 2030

Valori globali alla pagina 2044 Global values enable users to reuse identical values
between bots instead of creating new variables
for each bot. A user with the AAE_admin role
configures a global value with a default value and
can enable non-admin users to overwrite the value
to use in their bots.

Variabili Elemento di lavoro You can use the Work Item variables to pass the
Work Item attributes or values to the TaskBot from
the Control Room when you run the bot with the
option Run bot with queue.

Variabili predefinite
Predefined (or system) variables return the specific values about the machine on which the bot is
executed. Users cannot edit the values of a predefined variable.
I tipi di variabili predefinite includono appunti, data e ora, stringhe e impostazioni e parametri di sistema.
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Nota:  System variables are called as predefined variables in Automation 360.

Appunti

Use the actions in the Clipboard package to perform operations on the clipboard variable. Consulta
Clipboard package alla pagina 1435.

Variabile Descrizione

Clipboard Returns the contents of the clipboard.

Date time

Use the actions in the Datetime package to perform operations on the date time variables. Datetime
package alla pagina 1471

Variabile Descrizione

Date Returns the date including hours, minutes, and seconds.

Nota:  Hours can be in 24-hour or AM/PM format depending on the
machine configuration.

Day Returns the day in DD format.

Hour Returns the hours in HH format.

Machine Returns the device name as a string.

Millisecond Returns the milliseconds with a value between 0 and 999.

Minute Returns the minutes in MM format.

Month Returns the month in MM format.

Second Returns the seconds in SS format.

Year Returns the year in YYYY format.

Stringa
Use the following variables to change how a string is displayed.

Variabile Descrizione

Enter Starts a new line without returning to the beginning of the line
based on the operating system of the device. Ad esempio, la
variabile aggiunge sempre una nuova riga in Linux CentOS. In
Microsoft Windows, la variabile aggiunge un'interruzione di pagina
nell'applicazione Microsoft Word e una nuova riga nell'applicazione
Blocco note.

Newline Starts a new line and moves the cursor to the beginning of the next
line regardless of the application and operating system of the device.
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Variabile Descrizione

Separator Demarcates a separation between values with a <sep> value.

Tab Creates large space.

System settings and parameters

Use the following variables to return data from the computer that is connected to the running Bot Agent:

Variabile Descrizione

AAControlRoom Returns the URL of the Control Room.

AAInstallationPath Returns the Bot Agent installation path. Ad esempio, C:\Program
 Files\Automation Anywhere\Bot Agent.

AATaskExecutor Restituisce i dettagli su Esegui come utente utilizzato per eseguire
un bot. Se bot viene distribuito su un Bot Runner custodito, questa
variabile restituisce informazioni sull'utente connesso. Se bot viene
distribuito da un trigger, questa variabile restituisce informazioni
sull'utente associato a tale licenza Bot Runner.
This variable is a dictionary with the following keys:
• Executor_UserName
• Executor_FirstName
• Executor_LastName
• Executor_Email
• Execution_type: Returns the type of execution

• When you schedule a bot to run, the Execution_Type key
in the AATaskExecutor variable returns information about the
execution type with the schedule type (frequency) such as Run
 as schedule <Daily, Weekly, or Monthly>.

• When you use a trigger in a bot, the Execution_Type key can
be accessed through the trigger data. The Execution_Type
key returns the Run through Trigger as a string for
triggers. The Execution_type can be used in all the triggers.

AATaskInvoker Restituisce i dettagli sull'utente che ha distribuito il bot eseguendo
o pianificando il bot. Se il bot viene distribuito su un Bot Runner
assistito, questa variabile restituisce informazioni sull'utente connesso.
Se il bot viene distribuito da un trigger, questa variabile restituisce
informazioni sull'utente associato a tale licenza .
This variable is a dictionary with the following keys:
• Invoker_Email
• Invoker_FirstName
• Invoker_UserName
• Invoker_LastName

AATaskName Returns the path and name of the currently running TaskBot. Ad
esempio, /Bots/Finance/combineSheets.atmx.
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Variabile Descrizione

CPUUsage Returns the percentage utilization of the CPU.
Utilizza questa variabile in un'azione Attendi la condizione per
fare in modo che il bot l'attenda fin quando l'utilizzo della CPU del
computer si riduce a un livello specifico. Consulta Wait package alla
pagina 1923.

Machine Returns the name of the computer.

RAMUsage Returns the RAM usage in megabytes.
Utilizza questa variabile in un'azione Attendi la condizione per
fare in modo che il bot l'attenda fin quando l'utilizzo della RAM del
computer si riduce a un livello specifico. Consulta Wait package alla
pagina 1923.

OSName Returns the operating system. Ad esempio, Windows 10 a 64-bit.

TotalRAM Returns the total amount of RAM available.

• Version 11.3 contained Email, File, and PDF system variables, which could hold a limited number of
properties values. In Automation 360, an infinite amount of Email, File, and PDF properties values are
stored in User-defined Dictionary variables. Per ulteriori informazioni, consulta Using dictionary variable
for email properties alla pagina 1519 e Using a dictionary variable for PDF properties alla pagina 1740.

• Version 11.3 contained Excel system variables to return the cell, column, or row location. In Automation
360, the Excel Advanced package contains the following actions to return location values: Ottieni
indirizzo cella, Ottieni colonna e Ottieni riga.

• Version 11.3 contained the Counter system variable to return the loop iteration count. In Automation
360, the user must create and configure a number variable.

Le tue variabili (definite dall'utente)
Gli utenti e alcune actions creano variabili definite dall'utente per conservare temporaneamente dei valori.
Use this kind of variable to input values into an action (window title, login credential, or file path) or to
accept the output of an action (values read from a file or a Boolean return).
Quando si creano attività automatizzate, alcune actions hanno bisogno di fare riferimento e utilizzare alcuni
valori e questi valori possono essere memorizzati in variabili. Le variabili possono aiutare in diversi modi,
dal recupero di dati online al trasferimento di dati tra applicazioni, come Microsoft Excel. Una variabile può
contenere uno o più valori. I valori che una variabile può contenere e le operazioni che possono essere
eseguite sulla variabile sono determinate dal suo tipo di dati.

Nota:
• A bot can return only a maximum of 3 MB to an output variable. In addition, the table structure in

BotOutputVariable is limited to 300,000 cells.
If you insert more than 300,000 cells, an error message is displayed indicating that the debug variable is
too big to debug or that BotOutputVariable is too big to process.
Soluzione: Store the bot output on the device, such as in a .txt file. If the output must be shared
across multiple Bot Runners, store the output in a shared drive.

• The size of bot input variables is limited to 1900000 bytes. We recommend you use .txt file to store
large data set.
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Variable types

Il tipo di dati di una variabile è un attributo che determina il tipo di dati che il valore memorizzato nella
variabile può avere. I tipi di dati includono classificazioni di archiviazione, come interi, stringhe e caratteri.
Variabili come dizionario, record, elenco o tabella possono contenere più tipi di dati.
Most variable types have a package with a similar name, which contains actions used to perform
operations on the values stored in the variable. For example, use the actions in the String package to work
on String variables. Similarly, to work on Number variables, use the actions in the Number package. Per
convertire il valore di un tipo di variabile in un altro, vedere Conversione del tipo alla pagina 2034

Variable naming

Un nome di variabile può contenere un massimo di 50 caratteri Unicode, inclusi numeri (0-9), lettere latine
(A-Z, a-z) e caratteri speciali (- e _). You can use double-byte characters, such as Chinese, Japanese, or
Korean characters, in a variable name. Unicode range supported in variables alla pagina 2036
Raccomandiamo di usare la notazione a cammello per i nomi delle variabili e di mettere il prefisso al nome
della variabile per indicare lo scopo e il tipo di dati. For example, iFileEmailAttachment for a file type
variable that is used to provide an input.

Nota:  The following is a recommended naming standard for variables <type/scope
 indicator><data type><Variable name>. While there are many naming convention options,
some standards must be adopted and used consistently within the organization.
The <type/scope indicator> is a single character as follows:
• p = local variable (neither input nor output)
• i = input variable
• o = output variable
• io = input and output variable
• c = constant

Seguono alcuni altri esempi di denominazione delle variabili.
• iStrAuditLogPath: a string type variable received from a calling task
• oNumReturnValue : a number type variable returned to a calling task
• ioStrStatus: a string that is both received from and returned to a calling task
• cStrNull: a string that holds no value; for example, useful for string comparisons to check whether a

value is present

Per maggiori informazioni sull'ambito, vedere Task Bot package alla pagina 1895. Questo standard permette
di cercare le variabili per tipo. Per esempio, oStr restituisce variabili utilizzate per contenere i valori delle
stringhe di output.
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Variable types

Tipo di variabile e nome
suggerito

Descrizione Use examples

Qualsiasi
Any

Stores Boolean, Data table, Datetime, File,
Number, Record, String, or Window data
types. Use this variable type when you are
uncertain of which data type an action will
output.

Example of using
the Run action alla
pagina 2074

Operatore booleano
Bool

Stores either a True or False value.

Credenziale
Cred

Stores string values securely, preventing
values from being displayed in a message
box or written to a file. The value is either
selected from the Credential Vault or is
user-provided.
Credentials and credential variables in the Bot
editor alla pagina 2039

Data e ora
Date

Stores a value containing a single date and
time value.

You can format the
values by selecting a
predefined format or
specifying a custom
format.
Datetime formats alla
pagina 1475

Dizionario
Dict

Stores data in the form of key-value pairs.
The value can be boolean, number, or
string.
Dictionary package alla pagina 1479

• Using dictionary
variable for email
properties alla
pagina 1519

• Using a dictionary
variable for PDF
properties alla
pagina 1740

File
File

Stores a file path.
Example of using a file variable alla pagina
2104

Modulo
Form

Stores the value that was input into an
interactive form field.
Using interactive forms alla pagina 2186

Elenco
List

Stores a sequence of boolean, number, or
string values.
List package alla pagina 1675
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Tipo di variabile e nome
suggerito

Descrizione Use examples

Numero
Num

Stores numeric values, including integers
and decimals. Contiene valori compresi
tra -9.223.372.036.854.775.808 e
9.223.372.036.854.775.807 e fino a 15
cifre decimali.
You can assign a randomly generated value
to this variable.
action Numero casuale

You can remove
the digits following
a decimal when
converting the value
into a string.
Azione da numero a
stringa

Registra
Rec

Stores a single row of values extracted
from a table. The values can be boolean,
datetime, number, or string.
Variabile record alla pagina 2035

Example of entering
data into a web form
from a worksheet alla
pagina 2054

Sessione
Sess

Stores the session name from the Excel
basic, Excel advanced, or Terminal
Emulator packages. Passa questa variabile
da un bot padre a uno figlio nell'action
TaskBot > Esegui per consentire al bot
figlio di elaborare i dati nel file aperto nel
bot padre.

Nota:  Quando inizializzi questa variabile
nel bot figlio, seleziona Usa come input.

Example of sharing an
Excel session between
bots alla pagina
1899

Stringa
Str

Stores alphanumeric and special
characters, and empty values. It can
hold up to 65535 UTF-8 characters. Una
variabile stringa può contenere più righe di
testo.

You can compare
the value in a String
variable to an empty
String variable.
Example of using a
conditional statement
alla pagina 2058

Tabella
Table

Stores multiple values in a table of rows
and columns. The values can be boolean,
datetime, number, or string.

Assegna valori a
una variabile tabella
estraendo valori da
un file CSV/TXT, file
Excel o un modulo
Web.

Finestra
Win

Stores a window title and URL.
Quando si crea una variabile di tipo
Finestra, si noti che la selezione Browser
come valore predefinito supporta solo
le schede di Google Chrome, mentre
selezionando Applicazione come valore
predefinito si supporta qualsiasi finestra di
applicazione.

Some actions, such
as the Capture
action, create a
Window variable to
store the specified
window title and
URL.
Example of extracting
data from a web table
alla pagina 2053
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Eliminazione delle variabili

È possibile eliminare le variabili create dall'utente in uno dei seguenti modi:
• Eliminare una variabile: Nella tavolozza Variabili, fai clic sui puntini di sospensione verticali a destra

del nome della variabile e su Elimina variabile.
• Eliminare variabili inutilizzate: Nella tavolozza Variabili, fai clic su Elimina variabili inutilizzate,

seleziona le variabili da eliminare e fai clic su Elimina.

Attività correlate
Create a variable alla pagina 2030
Create a variable to store values.
Riferimenti correlati
Boolean package alla pagina 1421
The Boolean package contains actions that enable you to do various operations on boolean values.
Data Table package alla pagina 1439
Il package Data Table contiene actions che consentono di eseguire varie operazioni sui valori delle variabili
tabella. Use these actions to join or merge content, search for specific values, insert rows and columns,
remove duplicate rows, and write values to a file.
Datetime package alla pagina 1471
Un valore data/ora consiste in una data, un'ora e un fuso orario. RPA Workspace stores datetime values
in a Datetime variable. The Datetime package contains actions that enable you to perform various
operations on datetime values. You can use these actions to manipulate and compare values in the
Datetime variables.
Dictionary package alla pagina 1479
Il package Dizionario contiene actions che consentono di eseguire varie operazioni sui valori di tipo
dizionario.
List package alla pagina 1675
The List package contains actions that enable you to perform various operations on a variable of the list
data type.
Number package alla pagina 1695
Il package Number contiene actions che consentono di eseguire varie operazioni su una variabile numerica.
Una variabile numerica contiene valori numerici, inclusi numeri interi e decimali. Contiene valori compresi
tra -9.223.372.036.854.775.808 e 9.223.372.036.854.775.807 e fino a 15 cifre decimali.
String package alla pagina 1881
Utilizza il package String per eseguire varie operazioni come il confronto tra due stringhe, il recupero della
lunghezza della stringa o la conversione di una stringa in lettere maiuscole o minuscole.
Conversione del tipo alla pagina 2034
Puoi convertire temporaneamente i valori all'interno di una variabile booleana, numerica o stringa
da un tipo a un altro tipo (typecasting) per l'utilizzo all'interno di un'action. For example, use
$<YourStringVariable>.String:toNumber$ to convert the value of a string variable to a number
variable to perform mathematical operations.
Recursive expressions alla pagina 2035
Use a recursive expression to insert a variable in the place of an index or key of a dictionary, list, record, or
table variable.

Create a variable
Create a variable to store values.
When you create a variable that uses characters such as the underscore (_) or hyphen (-) in your variable
name, note that the underscore or hyphen are treated as the same character for the variable names. For
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example, global-temp_path is treated the same as global_temp-path. If you create a new variable that uses
variables different from these two characters, an error is displayed.
If you have created a global variable as global-temp-path, you can refer to this variable in any of the
following formats:
• global-temp-path
• Global-Temp-Path
• global_temp_path
• Global_Temp_Path

To create and configure a variable, perform the following steps:
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1. From the Bot editor, click Variables > Create variable (+ icon) at the top of the Variables menu.
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2. In the Create variable window, enter a descriptive name for the variable that is prefixed by a
lowercase letter to indicate the variable type.
For example, sCellValue to indicate a string data type.

Nota:
• You can use double-byte characters, such as Chinese, Japanese, or Korean characters, in a variable

name. Unicode range supported in variables alla pagina 2036
• Variables cannot be named Java keywords, such as String, Boolean, Integer, Public, and Finally.

3. Opzionale: Immetti una descrizione.

Recommendation:  Provide meaningful variable description when defining input or output variables.

4. Opzionale: Select the Constant (read-only) option to ensure values cannot be edited or overwritten.
5. Scegli tra le seguenti opzioni:

This field pertains to using a bot to run other bots. Consulta Task Bot package alla pagina 1895.
• Usa come input: The variable holds a value that can be passed from the parent bot to a child

bot. (Applicable only to a child bot)
• Usa come output: The variable holds a value that can be passed from a child bot to the parent

bot. (Applicable only to a child bot)
• Both: The value can be passed in both directions.
• Neither: The variable is confined to this bot; it cannot be shared across other bots.

The following example illustrates when to select Use as input or Use as output in a variable.
Suppose you want to add two numbers. The values are present in the parent bot, and the child bot
performs the calculations. For the parent bot to transfer the values to the child bot, the two variables
you created must be selected as Use as input so that the child bot can receive the values. Now, for
the parent bot to receive the calculated value, the variable that stores the result of the calculation in
the child bot has to be selected as Use as output.

Nota:  Ensure that you select the check boxes when you create a variable in the parent bot and the
child bot. When you build the bot, and if you edit the selection of check boxes, it might impact your
parent bot references, such as your parent bot might not work after this change.

6. Select a data type from the drop-down list.
For more information on data types, see Variable types alla pagina 2027.

7. Opzionale: Enter a default value to assign to the variable.
The values are NULL/empty by default.

8. Fai clic su Crea.
The variable appears in the Variables pane on the left side of the Bot editor.
If you want to edit a variable, you can change its name and value but not its data type.
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9. To insert a variable into an action field, perform one of the following actions:
• Click F2 to open the variables list.
• Click the Insert a value icon, located on the right side of the field.
• Enter the variable name. As you type, the field generates suggestions of existing variables.

Nota:  Add a dollar sign at the start and end of the variable. Ad esempio, $myVariableName$.

You can use the variable option and pass it as a parameter to open a file in packages such as XML,
Excel basic, or Excel advanced. Per aprire file con estensioni diverse, utilizza l'opzione variabile per
assegnare il percorso della cartella, il nome del file e l'estensione del file. First, create a variable for
the folder path, $sFolder$. Then, for the files in the folder path, create two variables, one for file
name $name$ and another for file extension $extension$. To open a file, combine the variables as
a string, such as $sFolder$\$name$.$extension$. Affinché l'estensione funzioni con diversi tipi
di file e diverse opzioni di apertura, è possibile aggiungere una logica condizionale.

Build a Go be Great bot alla pagina 2050: Follow the steps in this procedure for an example of how to create
a variable and assign it to an action.

Conversione del tipo
Puoi convertire temporaneamente i valori all'interno di una variabile booleana, numerica o stringa
da un tipo a un altro tipo (typecasting) per l'utilizzo all'interno di un'action. For example, use
$<YourStringVariable>.String:toNumber$ to convert the value of a string variable to a number
variable to perform mathematical operations.
Nel campo di testo, immetti $<nome variabile>.. After you enter the period, the auto-fill suggests
possible actions such as toNumber.

Tipo di variabile Opzioni di typecasting

Operatore
booleano

• invert: Converts the Boolean value to the opposite value (True to False and
False to True).

• toNumber: Converts the Boolean value to a numeric value (True to 1 and
False to 0).

• toString: Converts the Boolean value to a string value.

Numero • decrement: Decreases the number value by one.
• increment: Increases the number value by one.
• toString: Converts the number value to a string value.

Nota:  When you convert a number value to a string value and if the
number has a decimal value, the decimal value is removed after conversion.
For example, 15.234 will be shown as 15 when you convert it.

© 2023 Automation Anywhere. All rights reserved.     2034



    Automation Anywhere - Crea

Tipo di variabile Opzioni di typecasting

Stringa • length: Returns the number of characters in the string as a numeric value.
• lowercase: Converts the characters in the string to lowercase.
• reverse: Reverses the characters in the string.
• toBoolean: Converts the string value to a Boolean value.
• toNumber: Converts the string value to a number value. Qui si applicano i

limiti dell'action Da stringa a numero.
Vedi Da stringa a numero action.

• trim: Trims blanks and whitespaces from the string.
• uppercase: Converts the characters in the string to uppercase.

Nota:  Type casting is not supported for the following scenarios:
• As a value that is passed between bots.
• As a property value for an object captured with the Universal Recorder.

Proprietà oggetto alla pagina 1753

Recursive expressions
Use a recursive expression to insert a variable in the place of an index or key of a dictionary, list, record, or
table variable.
A recursive expression contains a variable nested inside of another variable (the outer variable). The value
of the outer variable is conditional based on the value of the nested variable.
For example, the list variable $listOfPlanets$ has the following values: Mercury, Venus, Earth, Mars,
Jupiter, Saturn, Uranus, and Neptune. The Number variable $indexPosition$ has value of 2. The
expression $listOfPlanets[$indexPosition$]$ returns Earth.
The following types of expressions are supported. You can create a recursive expression containing up to
10 expressions.
• $dictionaryVariable{$key$}$
• $listVariable[$index$]$
• $recordVariable[$index$]$
• $tableVariable[$rowIndex$][$columnIndexOrName$]$

Nota:
• You cannot use a Table variable within a List variable. For example, the following expression is not

supported: $vListStr[$vTable[0][0]$]
• You cannot combine expressions with properties. For example, the following expression is not

supported: $dictionaryVar{$listStrVar[2]$}.String:reverse$

Variabile record
A record variable holds a row of data extracted from a database, spreadsheet, or table in name-field pairs.
The fields can store values of Boolean, datetime, number, or string data type.
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Working with a record variable

Record variables are commonly used in the loop action to store a single row of retrieved data; you can
access a single value by specifying the index number or name. The index number is the position of the
name-field pair. The name is either configured when the variable is initialized or it can be extracted from
the column headers of the source table.
The following is an example table:

CustomerName City

Dana Pittsburgh

Sam Los Angeles

Alex Boston

In this example, a bot loops through the preceding table and assigns each row to rCurrentRow. To
retrieve the value from the first column of each row, use either the index number $rCurrentRow[0]$ or
name $rCurrentRow{CustomerName}$.

Nota:  To retrieve a date time value from a record variable and use it as a string, concatenate the record
variable with a string value in the action field.

Schema

A schema is like a template for the record fields. It sets the order of the fields and the type of data that
can be entered into each field.
If you select the Set schema option when creating a new record variable, the following conditions apply
at runtime, where the bot retrieves a row of data and stores it to a record variable:
• The retrieved values must match the configured field data types.

For example, the data set [{"name":"Sally"},{"id":002},{"dob":03/05/1989}] can
be assigned to a record variable with the schema [{"name":String},{"id":Number},
{"dob":Date}].

• The data set attributes must follow the same order and capitalization.
For example, the data set [{"name":"Henry"},{"id":003},{"dob":06/13/2001}] cannot
be assigned to a record variable with the schema [{"id":Number},{"name":String},
{"dob":Date}] or {"Name":String},[{"ID":Number},{"DOB":Date}].

• The record variable can accept a superset of the configured fields if the fields are in the same order.
For example, the data set [{"name":"Alex"},{"id":004},{"dob":12/10/1995},
{"pet":"yes"}] can be assigned to a record variable with the schema [{"name":String},
{"id":Number},{"dob":Date}].

• The record variable does not accept a subset of data.
For example, the data set [{"id":005},{"dob":05/21/1975}] cannot be assigned to a record
variable with the schema [{"name":String},{"id":Number},{"dob":Date}].

If the bot encounters a row of data that does not meet the record variable schema, the bot fails. This
prevents the bot from passing incorrect or invalid data into the next action.

Unicode range supported in variables
Review the valid characters that can be used in a variable name.
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Lingua Characters Intervallo

Arabo U+0600 - U+0605, U+0620 - U
+0669, U+066E - U+06D3

Comune U+4E00 - U+9FEA

Extension A U+3400 - U+4DB5

CJK ideographs

CJK compatibility ideographs U+F900 - U+FA6D

Chinese Chinese Kanji See CJK ideographs

Greco All alphabetical characters
(uppercase and lowercase)
are supported. For extended
characters ( ά έ ή ί ϊ ΐ ό ύ ϋ ΰ ώ
€)

U+0370 - U+0374,
U+0376 - U+0377,
U+037A - U+037D,
U+037F - U+0386,
U+0388 - U+038A,
U+038C, U+038E - U+03A1, U
+03A3 - U+03F5,
U+03F7 - U+03FF,
U+1F00 - U+1F15,
U+1F18 - U+1F1D,
U+1F20 - U+1F45,
U+1F48 - U+1F4D,
U+1F50 - U+1F57, U+1F59, U
+1F5B, U+1F5D,
U+1F5F - U+1F7D,
U+1F80 - U+1FB4,
U+1FB6 - U+1FBC, U+1FBE,
U+1FC2 - U+1FC4,
U+1FC6 - U+1FCC,
U+1FD0 - U+1FD3,
U+1FD6 - U+1FDB,
U+1FE0 - U+1FEC,
U+1FF2 - U+1FF4,
U+1FF6 - U+1FFC

Hiragana U+3041 - U+3096,
U+309D, U+309E

Katakana
full-width and half-width
characters

U+30A1 - U+30FA, U+30FC

Giapponese

Kanji See CJK ideographs
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Lingua Characters Intervallo

Double-byte numbers U+FF10 - U+FF19

Coreano Hangul Syllables U+AC00 - U+D7A3

Latino a-z
A-Z

U+0061 - U+007A
U+0041 - U+005A

Latin-1 supplement U+00C0 - U+00D6,
U+00D8 - U+00F6,
U+00F8 - U+00FF

Latin Extended-A U+0100 - U+017F

Latin Extended-B U+0180 - U+024F

Latin Extended-C U+2C60 - U+2C7F

Latin extended
(Czech, Danish, Dutch, Finnish,
French, German, Hungarian,
Italian, Norwegian, Polish,
Portuguese, Romanian, Spanish,
and Swedish)

Currency symbols U+20AC

Numeri 0-9 U+0030 - U+0039

Russo Cyrillic U+0400 - U+0481,
U+0483 - U+0487,
U+048A - U+04FF

Caratteri speciali Hyphen (-) and underscore (_) U+002D, U+005F

Use Work Item variables
You can use the Work Item variables to pass the Work Item attributes or values to the TaskBot from the
Control Room when you run the bot with the option Run bot with queue.
The Work Item variables are available in a TaskBot only after you attach a work item template to the
TaskBot when you define the work item template in the work item structure during queue creation.
Attach work item template to TaskBot alla pagina 2009
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Fai clic su Crea un bot.
3. In the Create a Taskbot window, enter the required parameters such as Name, Description, and

Folder location.
4. Click Create & edit to open the TaskBot in edit mode.
5. Attach the bot to a queue category by selecting a Work item template.

Attach work item template to TaskBot alla pagina 2009
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6. Press the function key F2 to open the Insert a variable window and add the following Workload
variables to an action:
a) workItem to view the default values or attributes of the Work Item when you run the TaskBot

using the Run bot with queue option.
The workItem is an input variable for debugging a Workload bot to be used for TaskBot
deployment options Run now and Schedule a bot. You can add the values for the workItem
variable when you create an automation.
On the other hand, when you use the option Run bot with queue, the workItem variable uses
the values passed on by the Control Room.

b) workItemResult to set the final outcome of the Work Item when you run the TaskBot using the
Run bot with queue option.
Use the String > Assign actionto set the value of workItemResult variable. This is an output
variable type and you can use the string values as well as other variables to set the value of
workItemResult variables.

The variables are read-only and therefore cannot be edited or deleted from the TaskBot editor page.
Double click a variable in the Variables panel to view the variable parameters:
• Variable name.
• Description of the variable.
• Read only if the Constant check box is selected when the variable was created.
• To be used as input or output parameter in a TaskBot during run time.
• Variable type.
• The default values or attributes that are configured with the Work Item template for a workItem

variable or the default output values for a workItemResult variable.

Concetti correlati
Gestione del carico di lavoro alla pagina 2797
Il modulo di gestione del carico di lavoro consente agli utenti di caricare file in formato Microsoft Excel e
CSV nella Control Room in modo che questa possa inserire i record dai file nelle distribuzioni dei bot.
Attività correlate
Define Work Item structure alla pagina 2803
Define the Work Item structure for processing in a queue. This enables you to manually upload the Work
Items from the system in the absence of ready data in a file.
Attach work item template to TaskBot alla pagina 2009
Attach a work item template to a TaskBot to use the TaskBot in workload automation.
Riferimenti correlati
Workload package alla pagina 1937
The Workload package enables you to insert work items in a queue for workload automation. It also
enables data chaining between multiple queues. You can orchestrate multiple bots, and enable optimal
device utilization through the queueing mechanism of workload management.

Credentials and credential variables in the Bot editor
Use credentials when building bots to pass sensitive information such as passwords and account numbers.
Using credentials separates the sensitive information from the bots and Bot Runners, which reduces the
risk of data spillage or unauthorized user access.

Credenziale La credenziale contiene le informazioni sensibili
negli attributi. An attribute can have a value that
is standard for all users or it can accept a user-
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input value. For example, an Email credential
can hold three attributes: host name (standard
value), username (user input), and password
(user input).
Credentials are predefined in the CREDENTIALS
tab and cannot be modified when the user is
building or running a bot.
Per impostazione predefinita, tutti gli utenti possono
creare, gestire e utilizzare le loro credenziali. A
user is granted access to another user's credentials
by receiving access to a locker that holds the
credential. Se la credenziale richiede un valore
immesso dall'utente, viene visualizzata nella scheda
RICHIESTE DI CREDENZIALI.
Una credenziale deve essere assegnata a un locker
per essere utilizzata per la creazione e l'esecuzione
di un bot.

Armadietto Un armadietto specifica quali utenti possono
visualizzare, modificare o accedere alle credenziali.
For example, a human resources (HR) locker can
hold Email, Database, and Training website
credentials and allow only specific employees of the
HR department to use the credentials in their bots.

Credential variable A credential variable stores a credential value in a
user-defined variable. It enables users to securely
pass values to a bot and from a bot to another bot.
Using a credential variable ensures that the values
are not displayed in a message box or written to a
file. The value is either selected from the Credential
Vault or is provided by the user. You can use it into
any action field that accepts a variable.

Nota:  Values of this data type cannot be converted
to another data type.

You can:
• Pass login credentials to a child bot.
• Retrieve confidential data, such as account

numbers, and pass them to the main bot.

Nota:  You cannot pass credential values to the
main bot when you deploy it from the Run bot
now page. The values must be hard-coded in the
bot or selected from the Credential Vault.

Working with credentials

• Only fields with a Credential tab below the field name accept a credential.
• Action fields display the locker, credential, and attribute name; users can not see attribute values in the

Bot editor.

© 2023 Automation Anywhere. All rights reserved.     2040



    Automation Anywhere - Crea

• A credential cannot be appended to other variables or to a string.

Attività correlate
Crea credenziali alla pagina 2842
Create a credential and add the required attributes.
Edit a credential alla pagina 2843
Modify credential details and add or remove attributes.

Example of building a bot that uses credentials
Build a bot that securely logs in to an online bank using credentials from Credential Vault, ensuring that the
username or password is not stored in the bot or on the device.
• Credentials must be assigned to a locker to be used in a bot.
• You must have Consumer permissions to the locker.

If the email notification setting is enabled, you receive an email that confirms the locker name and your
permissions to that locker.

In this example, you configure a credential with user-provided values and build a bot to automate logging
into an online bank website.
1. Provide the user-input values.

a) Navigate to BOTS > Credentials > CREDENTIAL REQUESTS.
The credentials that require a user-provided value have an incomplete icon in the first column.

b) Click the credential that holds the bank login credentials.
c) Fai clic su Modifica.
d) Enter the attribute values for the username and password and click Save changes.

2. Apri un nuovo bot.
a) Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei bots disponibili.
b) Fai clic su Crea nuovo > Bot.
c) Enter a bot name and click Create and edit.

3. Open the browser to the bank login page.
a) Fai doppio clic o trascina l'action Browser > Apri.
b) Enter the URL.

For example, www.examplebank.com/login.
Use an application page where you want to enter a credential.

c) Select your preferred browser.
d) Click Save and Run.

The bank website opens in a new window. If the website opens in a new tab, drag it into a
separate window.

4. Specify the username text box.
a) Fai doppio clic o trascina l'action Registratore > Acquisisci.
b) From the Object detail menu, select the window containing the bank website.
c) Fai clic su Acquisisci oggetto.

The window containing the bank website is activated.
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d) Hover over the username text box and click when a red outline appears.
e) In the Object properties table, verify that the Control Type is a textbox.
f) From the Action menu, select Set text.
g) Select the Select a credential option and click Pick to navigate to the credential.

The Pick a credential window appears.
h) Select the Locker, Credential, and Attribute for the bank website username and click

Confirm.

5. Repeat Step 4 to specify the password text box.
6. Specify the Log on button.

a) Fai doppio clic o trascina l'action Registratore > Acquisisci.
b) From the Object detail menu, select the window containing the bank website.
c) Fai clic su Acquisisci oggetto.

The window containing the bank website is activated.
d) Hover over the Log on button and click when a red outline appears.
e) In the Object properties table, verify that the Control Type is a button.
f) From the Action menu, select Click.

7. Close the window containing the bank website.
8. Click Save and Run.

Example of building a bot that uses credential variables alla pagina 2042
Perform the steps in this task to learn how to pass values securely between bots.
Riferimenti correlati
Pacchetto Recorder alla pagina 1751
Il package Registratore acquisisce una serie di compiti in un processo e poi li automatizza. Puoi
automatizzare le applicazioni aziendali (per esempio, applicazioni desktop, web, SAP e Java) usando
Recorder per acquisire le actions eseguite su oggetti dell'applicazione come una casella di testo, un
pulsante, una tabella, un pulsante di opzione, una casella combinata e una vista elenco.
Credentials and credential variables in the Bot editor alla pagina 2039
Use credentials when building bots to pass sensitive information such as passwords and account numbers.
Using credentials separates the sensitive information from the bots and Bot Runners, which reduces the
risk of data spillage or unauthorized user access.

Example of building a bot that uses credential variables
Securely pass values to a bot using credential variables to automate the process of logging in to a bank
website.
Complete the steps in the following task to build the child bot that automates logging in to a bank website:
Example of building a bot that uses credentials alla pagina 2041
Questa attività viene eseguita dall'utente che desidera creare e distribuire . Devi disporre dei diritti e delle
autorizzazioni necessarie per completare questa attività, nonché dell'autorizzazione per accedere alla  come
utente con licenza.
In this example, you modify the bot to accept credentials passed from a parent bot.
In the bot that you built for Example of building a bot that uses credentials alla pagina 2041, create two
credential variables and insert them into the Recorder > Capture actions.
1. Configure the credential variable to hold the username.
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Campo Inserisci

Nome nome utente

Usa come input seleziona

Tipo Credenziale

Valore predefinito Insecure string, leave field empty

2. Configure the credential variable to hold the password.
Campo Inserisci

Nome password

Usa come input seleziona

Tipo Credenziale

Valore predefinito Insecure string, leave field empty

3. Modify the first Recorder > Capture action.
a) Click the action to open it in the action editor.
b) In the Select a credential field, select the Variable tab.
c) Click F2 to open the Variables menu and select $username$.
d) Click Yes, insert.

4. Repeat the substeps in step 3 to insert the $password$ variable into the second Recorder >
Capture.

5. Click Save and Close
The Automation page appears.

Create a parent bot that will run the child bot and pass it the credential values.
6. Apri un nuovo bot.

a) Fai clic su Crea nuovo > Bot.
b) Enter a bot name and click Create and edit.

7. Insert a Task Bot > Run action to select the bot and provide the login credentials.
a) Fai doppio clic o trascina l'action TaskBot > Esegui.
b) In the Task Bot to run field, select the Control Room file tab.
c) Click Browse and select the bot that you modified in the above steps.
d) In the Input values options, select both Set username and Set password.
e) For each credential variable, click Pick to select the locker, credential, and attribute.

8. Click Save and Run.

Attività correlate
Create a variable alla pagina 2030
Create a variable to store values.
Riferimenti correlati
Task Bot package alla pagina 1895
Utilizza Esegui, Pausa e Sospendi actions nel package Task Bot per gestire l'esecuzione di uno o più
bots figlio da un bot padre o con un software di terze parti utilizzando un'API.
Credentials and credential variables in the Bot editor alla pagina 2039
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Use credentials when building bots to pass sensitive information such as passwords and account numbers.
Using credentials separates the sensitive information from the bots and Bot Runners, which reduces the
risk of data spillage or unauthorized user access.

Valori globali
Global values enable users to reuse identical values between bots instead of creating new variables for
each bot. A user with the AAE_admin role configures a global value with a default value and can enable
non-admin users to overwrite the value to use in their bots.

Data types

Tipo di dati Descrizione

Data e ora Stores a value containing a single date and time value.

Numero Stores numeric values, including integers and decimals. It can hold up
to 15 decimal digits.

Stringa Stores alphanumeric and character values.

Operatore booleano Stores a Boolean value as True or False, default value is False.

Working with global values

Nota:  The maximum number of public global values that can be created by an admin user is 150.

Users can perform the following tasks:
• Create a global value as an admin.

Crea un valore globale alla pagina 2044
• Update the default value as a non-admin.

Overwrite the default value alla pagina 2046
• Delete a global value.

A user with the AAE_Admin role can delete a global value by hovering over the vertical ellipsis to the
right of the value, and clicking the Delete icon. When a global value is deleted, any overridden values
for that global value are also deleted.

• Insert global values into bots.
All action fields that accept a user-created variable accept a global value. Insert a global value into an
action field by pressing F2 or by clicking the Insert a value icon on the left side of the field.

Crea un valore globale
Come utente con il ruolo AAE_Admin, puoi creare un valore globale, configurare il tipo di dati, impostare il
valore predefinito e abilitare l'aggiornamento del valore da parte di utenti non amministratori.
1. Accedi come amministratore e naviga su Gestisci > Valori globali.

Viene visualizzata la pagina Tutti i valori globali con una tabella di valori globali.
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2. Fai clic su Crea valore globale.

Viene visualizzata la schermata Crea valori globali.
3. Inserisci un nome descrittivo di massimo 50 caratteri.

Nota:
• Quando il valore globale viene inizializzato, non puoi modificarne il nome.
• I valori globali non possono essere denominati parole chiave Java, come Stringa, Operatore

booleano, Numero intero, Pubblico e Infine.

4. Opzionale: Immetti una descrizione di massimo 255 caratteri.
5. Seleziona il tipo di dati dall'elenco a discesa.

Data types alla pagina 2044
6. Immetti il valore predefinito.

Nota:  Quando il valore viene inizializzato, non puoi modificarne il tipo.

7. Specifica se gli utenti possono sovrascrivere il valore:
• IMPOSSIBILE effettuare la modifica: il valore predefinito rimane costante in tutti gli utenti e

bots.
• È POSSIBILE effettuare la modifica: gli utenti possono sovrascrivere il valore predefinito da

utilizzare nei propri bots.

Nota:  Quando crei un valore globale, se imposti il suo ambito su IMPOSSIBILE effettuare la
modifica, non è possibile modificare l'ambito in È POSSIBILE effettuare la modifica in seguito. If
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you want the scope of the global value to be CAN be changed, delete the value and recreate it with
the scope set to CAN be changed.

8. Fai clic su Crea valore globale.

Overwrite the default value
Global values can be configured to allow non-admin users to overwrite the default value. When building
bots, use a global value for values that remain constant across all bots instead of creating a new variable
for every bot.
As a non-admin user, you can only overwrite the default value in global values with a changeable scope.
You can identify which global values have a changeable scope by checking the value in the Scope
changeable column in the All global values table.
To verify if a global value has a changeable scope and to overwrite the default value, do the following
steps:
1. Navigate to BOTS > Global values.

The All global values table appears. Each row shows the data type, value name, whether the scope
is changeable, and the last modified date and time.

2. Find the global value that has a changeable scope.
3. Move your mouse over the vertical ellipsis and click Edit global value.

The Edit global value page appears with the User value field enabled.
4. Enter the value that will overwrite the default value.

Nota:  This value will overwrite the default value of this global value in all of your bots.

5. Fai clic su Salva modifiche.

Bot dependencies
Bots dependencies are files and other bots that are required to run that bot successfully.
Attività correlate
Upload bot and its dependencies alla pagina 2046
You can upload Enterprise 11 or Enterprise 10 bots, their dependent bots, and other files that are required
to run a bot successfully in the Automation 360 Control Room.
View bots dependencies alla pagina 2047
You can view the files and bots that are added to a bot as its dependencies.
Riferimenti correlati
Bot dependencies alla pagina 2046
Bots dependencies are files and other bots that are required to run that bot successfully.

Upload bot and its dependencies
You can upload Enterprise 11 or Enterprise 10 bots, their dependent bots, and other files that are required
to run a bot successfully in the Automation 360 Control Room.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. In the PRIVATE tab, expand the Bots folder and select the folder in which you want to upload the

dependent files.
3. Click the Upload files icon.
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4. On the Upload files page, click Add files.
5. From the Open dialog box, select the files you want to upload and click Open.
6. Fai clic su Upload.

Attività correlate
Add bot dependencies alla pagina 2047
You must add the files that are required to run a bot as its dependencies.
View bots dependencies alla pagina 2047
You can view the files and bots that are added to a bot as its dependencies.

Add bot dependencies
You must add the files that are required to run a bot as its dependencies.
Ensure that the files you want to add as dependencies are uploaded in the Control Room, except for bots.
The system identifies the automatic dependencies for a bot and adds the required files and other bots as
its dependencies. However, for manual dependencies, you must identify the files and bots that are required
and add them as dependencies for a bot.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. In the PRIVATE tab, expand the Bots folder that contains the bot for which you want to add

dependencies.
3. Select the bot for which you want to add dependencies.
4. Select the Edit Task Bot icon from the actions menu (vertical ellipsis) on the right.
5. Select Dependencies from the actions menu (vertical ellipsis) on the top-right.
6. Expand the Bots folder and select the folder that contains the files you want to add as dependencies.
7. Select the files you want to add as dependencies from the Available files section and click the right

arrow.
8. Fai clic su Salva.
9. Click Return to editor if you want to update the bot or click Close to close the bot.

Attività correlate
View bots dependencies alla pagina 2047
You can view the files and bots that are added to a bot as its dependencies.
Upload bot and its dependencies alla pagina 2046
You can upload Enterprise 11 or Enterprise 10 bots, their dependent bots, and other files that are required
to run a bot successfully in the Automation 360 Control Room.

View bots dependencies
You can view the files and bots that are added to a bot as its dependencies.
1. In the PRIVATE or PUBLIC tab, expand the folder that contains the bot for which you want to view

dependencies.
2. Select the bot for which you want to view dependencies.
3. Select the View Task Bot icon from the actions menu (vertical ellipsis) on the right.
4. Select Dependencies from the actions menu (vertical ellipsis) on the top-right.

The system shows a list of files and bots that are added as dependencies for the bot.
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Attività correlate
Add bot dependencies alla pagina 2047
You must add the files that are required to run a bot as its dependencies.
Upload bot and its dependencies alla pagina 2046
You can upload Enterprise 11 or Enterprise 10 bots, their dependent bots, and other files that are required
to run a bot successfully in the Automation 360 Control Room.

Edit bot-dependent text-based files
As a Bot Creator, you can open, view, edit, and save bot-dependent text-based files directly inside the
workbench. Automation 360 supports more than 40 text-based file formats, such as TXT, XML, JSON, and
Javascript.
• È necessario disporre di una licenza Bot Creator.
• You must be assigned a custom role, with the View content and Check out permissions assigned at

the folder level.

If you have the Check in permission, you can check in the edited files to the public workspace.
1. Log in to the Control Room as Bot Creator.
2. In the Private page, expand the Bots folder and select the folder that contains the bot-dependent

text-based files that are added as dependencies.

Nota:  You can edit only the text-based dependent files.

3. Select the file that you want to edit.
4. From the actions menu (vertical ellipses) on the right, click Edit file to open the file in the text editor.

The file opens up with all the formatting effects.
For example, XML files open up with the same formatting as that in code editor, providing you with a
similar experience.

5. Make changes to the file and click Save.
The changes made to the file are saved.

6. Fai clic su Chiudi.

Check out non-bot file dependencies
Check out the specific versions of the non-bot file dependencies from the public workspace to the private
workspace to create an editable copy of the file.
Ensure you have completed all the prequisites for checking out non-bot file dependencies: Prerequisites for
checking out bot and dependencies.
1. Accedi a Control Room come Bot Creator o utente Citizen Developer.
2. Nel pannello di sinistra, fai clic su Automazione.

A list of available bots, forms, and non-bot files are displayed.
3. You can choose to check out either one file or multiple files simultaneously.

• Select the file dependency that you want to check out, click the actions menu (vertical ellipsis), and
click Check out file.

• Select the file dependencies that you want to check out and click Check out checked items.

Opzione Fasi

Estrai file Select this option to check out the latest version of the dependent file.
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Opzione Fasi

Opzioni avanzate Select this option to select a specific version of the dependent file to check
out.
a. Click Advanced optoins.
b. Select the version of the dependent file to check out.
c. Add or remove further dependencies if any.
d. Select the version of these dependencies.
e. Review the dependencies (Overwritten, Missing, Cloned,

Skipped.)
f. Clicca su Estrai.

The file appears in the same folder structure in the private workspace.
4. To cancel the checked-out dependent file, click the Cancel check out for file option.

Puoi utilizzare questa opzione dallo spazio di lavoro pubblico o privato.
In the public workspace, the file status changes to Public, and the file is available for check out by
another user with the appropriate permissions. In the private workspace, the file status changes to
New if any changes were made to the file. If there are no changes, the file is replaced with a clone.

View version history of non-bot file dependencies
You can now view the version history of your non-bot file dependencies such as TXT, XML, JSON, XLS,
VBS, CSV, Javascript files, to identify relevant changes performed by other users to your files on a specific
date and time along with the check-in messages.
È necessario disporre delle autorizzazioni di archiviazione e di estrazione.
You can view the version history of the non-bot file dependencies available in the public workspace and the
private workspace (only if there are checked-out files). However, there is no version history available for
new and cloned files.
1. Accedi a Control Room.
2. Nel pannello di sinistra, fai clic su Automazione.

A list of bots, forms, and dependencies are displayed.
3. Select the dependency file for which you want to view the version history. Hover over the actions

menu (vertical ellipsis) on the right and click View history file.
A message appears listing all the versions of the selected file in a sequence (latest revision on the top
and first revision at the bottom). The information includes the version number, check-in message, date
and time of check-in, and the username that made the check-in.

Get started building bots
Use the following three examples to become familiar with building bots using in the cloud-based Bot editor.
These examples demonstrate using actions and the Universal Recorder to automate tasks in applications
and browsers.

Build a Go be Great bot alla pagina 2050 Build a basic bot using a Message Box action and
a variable. Segui questi passaggi per creare il primo
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bot che stampa il messaggio Go be great!, la
versione Automation Anywhere di Hello World!

Build a basic bot that uses a desktop application alla
pagina 2052

Build a bot that uses a conditional statement to
verify that the calculator is open, then uses the
calculator to multiply two numbers. This example
uses actions from the Application, If, Simulate
keystrokes, Message Box, and Window packages.

Example of extracting data from a web table alla
pagina 2053

Crea un bot per aprire una finestra del browser sul
sito Web Wikipedia, estrai i dati da una tabella e
scrivili in un file CSV sul desktop. This example uses
actions from the Browser, Data Table, Recorder,
and Window packages.

For more examples, see Examples of building bots alla pagina 2054.

More resources

• Per saperne di più, cerca Hello Automation 360 Bot:Corso Introduzione alla creazione di bot in Automation
Anywhere University: RPA Training and Certification (A-People login required).

• You can also visit the Learn section of the developer portal for more guidance. Find learning journeys and
videos for both new and experienced developers on how to build your first bots.

Build a Go be Great bot
Build a basic bot using a Message Box action and a variable. Segui questi passaggi per creare il primo bot
che stampa il messaggio Go be great!, la versione Automation Anywhere di Hello World!
To build a bot you must already have done the following:
• Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039
• Set user device credentials alla pagina 1052

If you have already completed the steps in Creazione del primo bot alla pagina 1059, skip to Step 6.
1. Create a new bot:

a) Nel pannello di sinistra, fai clic su Automazione.
b) Fai clic su Crea nuovo > Bot.
c) In the Create Task Bot window, enter the bot name.
d) Accept the default folder location: \Bots\

To change the default bot storage location, click Choose and follow the prompts.
e) Fai clic su Crea e modifica.

2. Inserisci una Finestra di messaggio action.
a) Fai clic su Azioni.
b) Search for the Message Box package.

Fai clic nella casella di ricerca Azioni e digita la parola messaggio. Fai clic sulla freccia per
espandere le opzioni Message Box.

c) Fai doppio clic o trascina l'action Finestra di messaggio su Bot editor (spazio aperto a destra).
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3. Nella finestra di dialogo a destra, specificare le condizioni per l'action Finestra di messaggio.
a) Nel campo Inserisci il titolo della finestra di messaggio, immetti Il mio primo bot!.
b) Nel campo Inserisci il messaggio da visualizzare, immetti Go be great!.
c) Accetta i valori predefiniti nel campo Barra di scorrimento dopo le linee e della casella di

controllo Chiudi finestra di messaggio dopo.

4. Fai clic su Salva.
Il tuo bot è pronto per l'esecuzione.
Puoi visualizzare il tempo impiegato per creare un bot navigando in Automazione > Home > Le
mie metriche. La tabella TaskBot attivi mostra il tempo richiesto per creare ogni bot. Quando un
bot viene modificato, la tabella mostra il tempo totale impiegato sul bot.
Ad esempio, se impieghi 10 minuti per creare e salvare un file bot, nella tabella TaskBot attivi viene
visualizzato 10 minuti. Se impieghi altri 5 minuti per modificare lo stesso bot, nella tabella TaskBot
attivi viene visualizzato un tempo totale di 15 minuti.
Analogamente, il campo Tempo medio impiegato per creare un TaskBot nella pagina Le mie
metriche mostra il tempo medio impiegato da tutti gli utenti per tutti i bots.
For example, if user 1 spends 120 minutes on Bot A, user 2 spends 2 minutes on Bot B, and user 3
spends 4 minutes on Bot C, the average time is calculated as (120+2+4)/3 = 42 minutes.

5. Test your bot.
Click Run at the top right.
The bot displays a Message box with the text Go be great!.

In the following steps, you configure a variable and insert it in the Message box.
6. Create a variable.

a) Click Variables from the accordion menu on the left panel.
b) Click Create variable (the + sign).
c) Enter vHelloWorld in the name field.
d) Select the Use as output option.
e) Enter Say Go be Great! with a variable in the Default value field.
f) Fai clic su Crea.

7. Assign the vHelloWorld variable to the Enter the message to display field.
a) Click the Message box action in the Bot editor.
b) In the dialog box, delete the text from the Enter the message to display field.
c) Either press the F2 key or click the Insert variable icon.

The Insert variable icon is located on the right-side of the text field.
d) Select vHelloWorld from the drop-down list.
e) Click Yes, insert.

8. Fai clic su Salva.
9. Fai clic su Esegui.

The bot displays a Message box with the text Say Go be Great! with a variable.

After you successfully run your bot, go to Build a basic bot that uses a desktop application alla pagina 2052.
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Build a basic bot that uses a desktop application
Build a bot that uses a conditional statement to verify that the calculator is open, then uses the calculator
to multiply two numbers. This example uses actions from the Application, If, Simulate keystrokes, Message
Box, and Window packages.
To build a bot you must already have done the following:
• Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039
• Set user device credentials alla pagina 1052

1. Apri un nuovo bot.
a) Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei bots disponibili.
b) Fai clic su Crea nuovo > Bot.
c) Enter a bot name and click Create and edit.

2. Insert an conditional sequence that verifies that the calculator is open and activates the window.
a) Double-click or drag the If action.
b) Select Window exists from the Condition drop-down list.
c) Select the Application tab and click the refresh icon to display all open applications.
d) Select Calculator from the Window drop-down list.

The Calculator window is saved to the variable window-1.
e) Drag the Message box action into the If container.
f) In the Enter the message to display field, enter The calculator is running.
g) Drag the Window > Activate action into the If container below the Message box action.
h) In the Window field, insert the window-1 variable.

3. Insert an alternative sequence that opens the calculator.
a) Double-click the If > Else action.
b) Drag the Message box action into the Else container.
c) In the Enter the message to display field, enter The calculator is not running.
d) Drag the Application > Open program/file action into the If container below the Message

box action.
e) In the Location of the program/file field, enter C:\Windows\System32\calc.exe.

4. Insert the Simulate keystrokes action to perform the calculation.
a) Drag the Simulate keystrokes action below the If and Else containers.
b) In the Window field, insert the window-1 variable.
c) In the Keystrokes field, enter 5*5=.
d) In the Delay field, enter 500.

5. Click Save to save the bot.

© 2023 Automation Anywhere. All rights reserved.     2052



    Automation Anywhere - Crea

6. Run the bot.
When the bot runs, the The calculator is not running message appears, then the Calculator
window opens, and the calculation is performed.

7. Run the bot again.
When the bot runs, the The calculator is running message appears, then the Calculator
window activates, and the calculation is performed.

If the bot does not input all of the numbers into the calculator, try increasing the keystrokes delay.

Example of extracting data from a web table
Crea un bot per aprire una finestra del browser sul sito Web Wikipedia, estrai i dati da una tabella e scrivili
in un file CSV sul desktop. This example uses actions from the Browser, Data Table, Recorder, and Window
packages.
To extract data from a table, do the following steps:
1. Create a new bot:

a) Nel pannello di sinistra, fai clic su Automazione.
b) Fai clic su Crea nuovo > Bot.
c) In the Create Task Bot window, enter the bot name.
d) Accept the default folder location: \Bots\

To change the default bot storage location, click Choose and follow the prompts.
e) Fai clic su Crea e modifica.

For information about bot naming conventions, see Creazione del primo bot alla pagina 1059.
2. Open a browser window to the web page from which you will extract the table.

a) Fai doppio clic o trascina l'action Browser > Apri.
b) Select your preferred browser.
c) In the Link to open field, enter https://en.wikipedia.org/wiki/

Table_(information).
d) Fai clic su Salva.
e) Fai clic su Esegui.

The bot opens the window.
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3. Specify the table.
a) Fai doppio clic o trascina l'action Registratore > Acquisisci.
b) From the far-right panel, in the Window options, select the Browser tab and then select the

Table (information) - Wikipedia window from the drop-down list.
Se il titolo della finestra non compare nell'elenco, fai clic su Aggiorna.

c) Fai clic su Acquisisci oggetto.
La finestra Tabella (informazione) - Wikipedia si attiva.

d) Passa sopra la tabella Età sotto la voce Descrizione di base.
An orange box appears, surrounding the table.

e) Click the table.
Viene visualizzata la finestra di messaggio Elaborazione oggetto in corso.

f) Return to the Control Room.
g) In the Object properties table, verify the Control Type is TABLE.

In caso contrario, fai clic su Riacquisisci oggetto.
h) From the Action to take on object drop-down list, select Get table.
i) In the Save the outcome to a variable field, create the Tabledata variable.

The Table (information) - Wikipedia window is saved as the variable window-1.
4. Specify the file where to save the data.

a) Fai doppio clic o trascina l'action Tabella dati > Scrivi su file.
b) From the Data table name list, select Tabledata.
c) Provide a file path to create a CSV file.

Ad esempio, C:\Users\<username>\Desktop\WikipediaTable.csv.
d) Seleziona l'opzione Crea cartelle/file se non esistono .
e) Select to overwrite the existing file.

5. Chiudi la finestra Tabella (informazione) - Wikipedia.
a) Fai doppio clic o trascina l'action Finestra > Chiudi.
b) Select the Variable tab and insert window-1.

6. Fai clic su Salva.
7. Fai clic su Esegui.

The bot creates a CSV file on the desktop with data on seven indexes, their values, and net change.

Examples of building bots
Use these example tasks to become familiar with the features and learn to build bots in Automation 360.

Example of entering data into a web form from a worksheet
In this example, you build a bot to enter multiple rows of data from an XLSX sheet into a web form. Use
actions from the Excel advanced, Loop, and Recorder packages.
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Before you start building the bot, you can create the following data sets on your desktop in .xlsx format
as below.

Employee name Age Claim amount Claim date Claim type

Mike 30 469 22/3/2022 Medico

Sarah 34 766 28/3/2022 Dental

Chris 41 428 13/05/2022 Medico

Samantha 45 1000 2022-09-05 Medico

To retrieve values from an Excel file and input them into a web form, do the following:
1. Create a new bot:

a) Nel pannello di sinistra, fai clic su Automazione.
b) Fai clic su Crea nuovo > Bot.
c) In the Create Task Bot window, enter the bot name.
d) Accept the default folder location: \Bots\

To change the default bot storage location, click Choose and follow the prompts.
e) Fai clic su Crea e modifica.

2. Apri il file Excel.
a) Double-click or drag the Excel advanced > Open action.
b) Inserisci un nome della sessione.
c) Select the Excel file.
d) Contrassegna l'opzione Il foglio contiene un'intestazione.

Contrassegnando l'opzione Il foglio contiene un'intestazione, consenti al bot di cercare la colonna
in base al nome dell'intestazione durante l'esecuzione.

3. Launch the website.
a) Fai doppio clic o trascina l'action Browser > Apri.
b) Enter the website URL which consists the webform to update the data.

4. Retrieve the worksheet values and store them in a Table variable.
a) Double-click or drag the Excel advanced > Get multiple cells action.
b) Enter the same session name you used in the Excel advanced > Open action.
c) Select All rows from the drop-down list.
d) Create a Table variable using the icon to the right of the Assign to variable drop-down list.
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5. Instruct the bot to process the data row by row.
a) Double-click or drag the Loop action.
b) Select the For each row in table iterator.
c) Select the same Table variable that you used in Get multiple cells.
d) Create a Record variable using the icon to the right of the Assign to variable drop-down list.

The Record variable holds all of the values for one row. With each iteration of the Loop, the bot
retrieves the values of the next row and stores them in the Record variable, overwriting the values
from the previous row.

6. Map the first column header to the web form textbox.
a) Double-click or drag the Recorder > Capture action.
b) Select the same window you opened with the Open action.
c) Fai clic su Acquisisci oggetto.
d) Hover over the textbox until a red outline appears.
e) Click the textbox.
f) Return to the Control Room.
g) Verify that the Control Type value is TEXTBOX.
h) Select Set text from the Action drop-down list.
i) In the Keystrokes field, insert the same Record variable that you used in the Loop.
j) Select the By name option and copy-paste the first column header into the field.

7. Repeat the sub-steps in step 5 to map the other columns, with the following differences:
a) Instead of searching for the browser window title, insert the Window variable generated by the

Recorder.
b) When inserting the Record variable in the Keystrokes field, copy-paste the subsequent column

header into the "By name" field.

8. Capture the Submit button.
a) Double-click or drag the Recorder > Capture action.
b) Insert the Window variable generated by the Recorder.
c) Fai clic su Acquisisci oggetto.
d) Verify that the Control Type value is BUTTON.
e) Select the Click action.

9. Fai clic su Salva.

Riferimenti correlati
Excel advanced package alla pagina 1533
Il package Excel advanced contiene actions che consentono di automatizzare molte delle attività ripetitive
quando si lavora con i fogli di calcolo di Microsoft Excel.
Loop package alla pagina 1681
Utilizza il Loop Pacchetto per eseguire una sequenza di actions ripetutamente per un numero specifico di
volte o fin quando una condizione specifica non sarà soddisfatta.
Pacchetto Recorder alla pagina 1751
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Il package Registratore acquisisce una serie di compiti in un processo e poi li automatizza. Puoi
automatizzare le applicazioni aziendali (per esempio, applicazioni desktop, web, SAP e Java) usando
Recorder per acquisire le actions eseguite su oggetti dell'applicazione come una casella di testo, un
pulsante, una tabella, un pulsante di opzione, una casella combinata e una vista elenco.

Esempio di trasferimento di un valore tra bots
Scopri come trasferire un valore da un TaskBot all'altro utilizzando una variabile dizionario.
Build a parent TaskBot and a child TaskBot that do the following:
• The parent bot prompts the user to enter a song title and passes it to the child bot.
• The child bot takes the input string and returns a new string to the parent bot.
• The parent bot receives the string that the child bot passes as a dictionary.

1. Build a child bot.
a) Dall'interfaccia Control Room, seleziona Bot > I miei bot.
b) Fai clic su Crea nuovo > bot.
c) Enter the name for the bot as GetSongDetails.
d) Fai clic su Crea e Modifica.

2. Create a variable named sMySong.
a) In the Variables panel, click the Create variable button.
b) In Type, select String if it is not already selected.
c) In Name, enter sMySong.
d) Select the Use as input and Use as output check boxes.
e) Fai clic su Crea.

3. To build a return string, use the String > Assign action.
a) From the Actions panel, find the String > Assign action, and add it to the child bot flow.
b) In Select the source string variable(s)/ value, enter I love $sMySong$ too!.

During runtime, $sMySong$ in the output string will be replaced with the value that the parent
bot passes to the child bot.

c) In Select the destination string variable, select sMySong to store the new string.
d) Fai clic su Salva.

4. Crea il bot padre.
a) Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco di bot e moduli disponibili.
b) Fai clic su Crea nuovo > bot.
c) Enter the name for the bot as FavoriteSong-Parent
d) Fai clic su Crea e Modifica.

5. Create a variable named sMySong.
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6. Use the Prompt > For value action to capture a song title.
a) From the Actions panel, find and add the Prompt > for value action to the parent bot flow.
b) In the Prompt window caption field, enter Favorite Song.
c) In the Prompt message field, enter Type the title of your favorite song.
d) Nel campo Assegna il valore a una variabile, immetti sMySong.
e) Fai clic su Salva.

7. Use the Task Bot > Run action to call the child bot:
a) From the Actions panel, find and add the Task Bot > Run action to the parent bot flow.
b) In Task Bot to run, select Control Room and then click Choose.
c) Click Browse and navigate to the folder that contains the child bot and select

GetSongDetails.
d) In Input values, select Set sMySong and then enter $sMySong$ in the variable field.
e) In Save the outcome to a variable (option), select Dictionary and then create a variable

named dOutput.
f) Fai clic su Salva.

8. Use the Message box action to display the string that the child bot returns.
a) From the Actions panel, find and add the Message box > Message box action to the parent

bot flow.
b) In Enter the message box window title, enter Automation Anywhere Enterprise

 Client.
c) In Enter the message to display, enter $dOutput{sMySong}$.

The name of the output variable that the child bot uses is used as the key for retrieving the value
from the dictionary variable.

d) Fai clic su Salva.

9. Test the bot.
a) Click Run to run the bot.

After bot is deployed, the Favorite Song input box opens.
b) In the Favorite Song input box, enter a song title.
c) Fai clic su OK.

A message box should display the string that the child bot returns. If no value returns, then
review the procedure to assign the incoming value to a dictionary key and a variable.

Riferimenti correlati
Dictionary package alla pagina 1479
Il package Dizionario contiene actions che consentono di eseguire varie operazioni sui valori di tipo
dizionario.

Example of using a conditional statement
In this example, you build a bot that prints a message based on whether a cell has a value or is empty.
Use the actions from the Excel basic or Excel advanced, If, and Message Box packages.
Before building this bot, save an empty Excel worksheet to the desktop.
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Because this bot does not create a new Excel worksheet, you can use either the Excel basic or Excel
advanced packages.

Nota:  All of the actions must be from the same package.

1. Apri un nuovo bot.
a) Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei bots disponibili.
b) Fai clic su Crea nuovo > Bot.
c) Enter a bot name and click Create and edit.

2. Use the Open action from the Excel basic or the Excel advanced package to open the Excel sheet.
a) Double-click or drag the Open action.
b) Inserisci un nome della sessione.
c) Click Browse to provide the file path to the empty Excel worksheet on the desktop.

3. Use the Get single cell action to assign the value of a cell to a string variable.
a) Double-click or drag the Get single cell action from the same package that you used for the

Open action.
b) Provide the session name that you used in the Open action.
c) Select the Active cell option.
d) In the Store cell contents to field, create the variable Output.

4. Use the If action to configure the conditional statement.
a) Double-click or drag the If action.
b) Select String from the Condition drop-down list.
c) In the Source value field, insert the variable Output.
d) Select Equals to as the Operator.
e) Leave the Target value field empty.

5. Insert a Message box into the If container.
a) Drag the Message box action.
b) In the Enter the message to display field, enter Cell is empty.

6. Use the Else and Message box actions to configure the alternative sequence of actions.
a) Drag the Else action next to the If action.
b) Drag the Message box action into the Else container.
c) In the Enter the message to display field, enter Cell is not empty.

7. Fai clic su Salva.
8. Run the bot.

As the bot runs, the message box appears with the message Cell is empty.
9. Enter a value into the cell located at A1 in the Excel sheet and save the sheet.
10. Run the bot.

As the bot runs, the message box appears with the message Cell is not empty.
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Riferimenti correlati
Excel advanced package alla pagina 1533
Il package Excel advanced contiene actions che consentono di automatizzare molte delle attività ripetitive
quando si lavora con i fogli di calcolo di Microsoft Excel.
If package alla pagina 1625
Utilizza le actions nel package If per controllare la sequenza di esecuzione in base a una o più condizioni di
un'attività.
Message box package alla pagina 1690
Use the Message box action from the Message box package to insert a message box that shows a
message when the task runs. For example, you can insert a Message Box action to follow a web form so
that the action displays the message: Web Form Filled and Complete.

Example of using Python script to join a list
Build a bot that uses a Python function to print the message Go Be Great!, the Automation Anywhere
version of Hello World. In this example, the bot combines a list of string values and prints them to a
message box.
To run Python script from Automation 360, you must already have the latest version of Python 3.x installed
on your device.
1. Create a new bot:

a) Nel pannello di sinistra, fai clic su Automazione.
b) Fai clic su Crea nuovo > Bot.
c) In the Create Task Bot window, enter the bot name.
d) Accept the default folder location: \Bots\

To change the default bot storage location, click Choose and follow the prompts.
e) Fai clic su Crea e modifica.

2. Create a variable to hold the list values:
a) Click the Create variable icon.
b) Enter lArgument in the Name field.

Recommendation:  Prefix the variable name with a lowercase character to indicate the variable
data type.
Variable naming alla pagina 2027

c) Select the List type and String subtype.
d) In the Default value field, enter the following values:

1. Value at 0: Go
2. Value at 1: Be
3. Value at 2: Great
4. Value at 3: !

e) Fai clic su Crea.
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3. Provide the script with a Python Script > Open action:
a) Double-click or drag the Python Script > Open.
b) Select the Manual input option.
c) Copy and paste the following text into the Enter script here field.

def data ( str ):
    x = " ".join( str )
    return x

4. Use a Python Script > Execute function action to tell the bot to run the script:
a) Double-click or drag Python Script > Execute function.
b) Enter data in the Enter name of function to be executed field.
c) Select the lArgument variable from the Arguments to the function drop-down list.
d) Create the variable sOutput for the Assign the output to variable field.

5. Insert a Message box action to hold the Python function output:
a) Double-click or drag the Message box > Message box action.
b) In the Enter the message to display field, select and insert the variable sOutput.
c) Select the Close message box after option. Retain the default value of 5 seconds in the field.

6. Close the script execution session with a Python Script > Close action:
a) Double-click or drag Python Script > Close.
b) Fai clic su Salva.

7. Click the Run icon.
The bot generates a message box with the text Go Be Great!. After 5 seconds, the message box
disappears.
To review the bot launcher logs, navigate to C:\ProgramData\AutomationAnywhere
\BotRunner\Logs\<current month>\Bot_Launcher-<today's date>.log.zip. Each
zipped folder contains a file with data on the code execution, which is useful for debugging.

Riferimenti correlati
Python Script package alla pagina 1746
Il package Python Script contiene actions che abilitano le funzioni Python Script in un'attività.
Message box package alla pagina 1690
Use the Message box action from the Message box package to insert a message box that shows a
message when the task runs. For example, you can insert a Message Box action to follow a web form so
that the action displays the message: Web Form Filled and Complete.

Example of using the DLL package
Build a very simple DLL that will generate a message. Create a bot to run the DLL.
This topic shows how to create a DLL package. If you do not have Microsoft Visual Studio, download the
free Community version from Microsoft Visual Studio Community IDE.
Create the DLL package.
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1. In Microsoft Visual Studio, create a new class library that will generate a file type .dll by using C#.
a) Navigate to File > New > Project.
b) Search for dll in the Search for templates field.
c) Select the C# library option.
d) Configure your project as follows:

• Project name: DemoDLL
• Location: [Any]
• Solution Name: DemoDLL

e) Fai clic su Crea.
f) Copy the following code and replace the contents of class1.cs by pasting:

using System;
using System.Collections.Generic;
using System.Linq;
using System.Text;
using System.Threading.Tasks;

namespace DemoDLL
{
    public class CallMe
    {
        public string ImHere()
        {
            String Reply = "You are now inside the DemoDLL, ImHere
 function!";
            return Reply;
        }
    }
}

g) In Solution Explorer, right-click Class1.cs and rename it to "CallMe.cs".
h) Navigate to File > Save All.
i) Navigate to Build > Build Solution.

The output window confirms that the DLL package was successfully created and displays the path
to your new DemoDLL.dll package in the Output window. Note the package location, as you will
need it later to enter into the bot.

Create a bot to execute the DLL package.
2. Create a bot.

a) Nel pannello di sinistra, fai clic su Automazione.
Viene visualizzato un elenco di bot e moduli disponibili.

b) Fai clic su Crea nuovo > bot.
c) Provide a name for thebot: MyDLLbot
d) Immetti la posizione della cartella: Bots\TaskBotExample
e) Fai clic su Crea e Modifica.

3. Create a variable: sReturnedString: string type.
Create a variable alla pagina 2030
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4. Use a DLL > Open action to load your DLL package.
a) From the Actions pane, double-click or drag the DLL > Open action.
b) In the DLL:Open, Filepath field, select file type Desktop file and click Browse to find your

DLL package. Fai clic su Apri.
c) Fai clic su Salva.

5. Use a DLL > Run function action to execute your DLL package.
a) Double-click or drag the DLL > Run function action to the last line of the bot.
b) Click Get DLL Details.
c) Select Desktop file type and then click Browse. Locate your DLL package and click Open.
d) Fai clic su Avanti.
e) Expand the DemoDLL namespace and select the CallMe function. Select method ImHere and

click Apply.
f) In the Assign the value to a variable field, select sReturnedString.

6. Use a Message box action to report what was returned from the DLL bot:
a) Double-click or drag the Message box action to the last line of the bot.
b) In the Enter the message to display field, type: From the DLL: "$sReturnedString$".

7. Fai clic su Salva.
8. Use the DLL > Close action to end the DLL session.

a) Double-click or drag the DLL > Close action to the last line of the bot.

9. Fai clic su Salva.
10. Click the List tab to view your code in text-only mode.

Your code should look like this:

Start
DLL:Open "C:\myFolder\source\repos\DemoDLL\DemoDLL\bin\Debug\DemoDLL.dll
 for session "Default"
DLL:Run function "ImHere" and store output in variable $sReturnedString$
 and session "Default"
MessageBox "From the DLL: "$sReturnedString$".
DLL:Close session "Default"
End

11. Esegui il tuo bot.
The DLL package returns a message to the bot: From the DLL: "You are now inside the
DemoDLL, ImHere function!".

Riferimenti correlati
DLL package alla pagina 1481
A dynamic-link library (DLL) file contains a shared library of functions that can be used by Windows
programs. The DLL package uses a .dll file as reference and calls functions from the bot.

Example of transferring data from CSV file to Excel worksheet
In this example, you build a bot to update the product inventory in an Excel worksheet with new product
names from a CSV file. Use actions from the CSV/TXT, Excel advanced, IF/ELSE, and Loop packages.
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Before you start building the bot, create the following data sets on your desktop in the specified file
formats:
Data set 1: ProductInventory.xlsx

Item number Nome Conteggio Categoria Prezzo per
unità

Taxable

A0001 Milk 15 Grocery 3 N

A0002 Eggs 6 Grocery 4 N

A0003 Flower 3 Garden 10 Y

A0004 Tabella 1 Home 50 Y

A0005 Towel 4 Home 10 Y

A0006 Dog Food 16 Pet 22 N

A0007 Paint 43 Home 12 Y

Data set 2: NewProductNames.csv

Item number Nome

A0005 Hand Towel

A0002 Chicken Eggs

A0003 Sunflower

A0004 Coffee Table

A0006 Dog Food - Small Dogs

A0007 Paint - Dark Blue

A0001 2% Milk

In this example, you will build a bot to update the product inventory in an Excel worksheet with new
product names from a CSV file. The Excel worksheet has old product names and the CSV file has new
product names. You will relate the data in the Excel worksheet and the CSV file with item number and
update the Excel worksheet with the new item name corresponding to the item number. Use actions from
the CSV/TXT, Excel advanced, IF/ELSE, and Loop packages
1. Create a new bot:

a) Nel pannello di sinistra, fai clic su Automazione.
b) Fai clic su Crea nuovo > Bot.
c) In the Create Task Bot window, enter the bot name.
d) Accept the default folder location: \Bots\

To change the default bot storage location, click Choose and follow the prompts.
e) Fai clic su Crea e modifica.
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2. Open the NewProductNames.csv file that you just created.
a) Fai doppio clic o trascina l'action CSV/TXT > Apri.
b) In the Session name field, enter session 1.
c) Provide the file path to NewProductNames.csv.
d) Select the Contains header option.

3. Open the ProductInventory.xlsx file that you just created.
a) Double-click or drag the Excel advanced > Open action.
b) In the Session name field, enter session 2.
c) Provide the file path to ProductInventory.xlsx.
d) Choose to open the file in Read-write mode.
e) Select the Contains header option.

4. Use the Go to cell action to indicate the first cell in which to update the product names.
a) Double-click or drag the Excel advanced > Go to cell action.
b) In the Session name field, enter session 2.
c) Select the Specific cell option and enter B2.

5. Use a Loop action to retrieve the cell values in each row from ProductInventory.xlsx.
a) Fai doppio clic o trascina l'action Loop.
b) Select the Excel Advanced > For each row in worksheet iterator.
c) In the Session name field, enter session 2.
d) In the Loop through field, select All rows.
e) In the Assign current value to this variable field, create a rInventory variable.

6. Use a Loop action to retrieve the cell values in each row from NewProductNames.csv.
a) Drag the Loop action into the For each row in worksheet Loop container.
b) Select the For each row in CSV/TXT iterator.
c) In the Session name field, enter session 1.
d) In the Assign current value to this variable field, create a rNewProduct variable.

7. Use an If action to compare the item number from ProductInventory.xlsx to the item number
from NewProductNames.csv to ensure they are the same before moving on to the next action.
a) Double-click or drag the If action into the For each row in csv/txt Loop container.
b) Seleziona la condizione Stringa.
c) In the Source value field, input rInventory[0].
d) Select the Equals to (=) operator.
e) In the Target value field, input rNewProduct[0].
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8. Use the Set cell and Go to cell actions to update the product name and move to the cell below.
a) Double-click or drag the Excel Advanced > Set cell action.
b) In the Session name field, enter session 2.
c) Select the Active cell option.
d) In the Cell value field, input rNewProduct{Name}

e) Double-click or drag the Excel Advanced > Go to cell action.
f) In the Session name field, enter session 2.
g) From the Active cell drop-down list, select One cell below.

9. Insert an alternative to the If action: if the item numbers are not the same, the bot continues to the
next row in NewProductNames.csv.
a) Drag the If > Else action.
b) Drag the Loop > Continue action.

10. Close the files.
a) Double-click or drag the Excel advanced > Close action.
b) In the Session name field, enter session 2.
c) Select the Save changes option.
d) Fai doppio clic o trascina l'action CSV/TXT > Chiudi.
e) In the Session name field, enter session 1.

11. Fai clic su Salva.
12. Run the bot.

The bot updates the ProductInventory.xlsx file to look like the following table:
Data set 3: ProductInventory.xlsx

Item number Nome Conteggio Categoria Prezzo per
unità

Taxable

A0001 2% Milk 15 Grocery 3 N

A0002 Chicken Eggs 6 Grocery 4 N

A0003 Sunflower 3 Garden 10 Y

A0004 Coffee Table 1 Home 50 Y

A0005 Hand Towel 4 Home 10 Y

A0006 Dog Food -
Small Dogs

16 Pet 22 N

A0007 Paint - Dark
Blue

43 Home 12 Y

Riferimenti correlati
CSV/TXT package alla pagina 1436
The CSV/TXT package contains actions that enable you to open a CSV or text file, read data from that
file, and assign the data to a Table variable. This package supports files encoded in ANSI, Unicode, UTF-8,
or Windows-1251, and can process up to one million records.
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Excel advanced package alla pagina 1533
Il package Excel advanced contiene actions che consentono di automatizzare molte delle attività ripetitive
quando si lavora con i fogli di calcolo di Microsoft Excel.
If package alla pagina 1625
Utilizza le actions nel package If per controllare la sequenza di esecuzione in base a una o più condizioni di
un'attività.
Loop package alla pagina 1681
Utilizza il Loop Pacchetto per eseguire una sequenza di actions ripetutamente per un numero specifico di
volte o fin quando una condizione specifica non sarà soddisfatta.

Run TaskBot to merge Excel sheets
Download and run sample TaskBot from the Bot Store to merge two spreadsheets.
Complete these requirements for using the example TaskBot:
• Microsoft Excel must reside on the Bot Runner device
• Automation 360 Build 4088 or later
• Excel Advanced package version 2.0.0-20200422-000103 or later
• Two spreadsheets as input: Both sheets must have common data within column A, such as a product or

customer number

You can manually create the spreadsheets with columns similar to the following tables 1 and 2.
Sheet 1 has columns to append to sheet 2 where a common value resides in column A. The bot
expects the file locations and names to be c:\bot_test\Spreadsheet1.xlsx and c:\bot_test
\Spreadsheet2.xlsx.
Table 1

Item
Number

Nome Conteggio Categoria Unit
Price

Taxable Backorder Perishable Locale

A0001 Milk 15 Grocery 3 N Y Y Stati
Uniti

A0005 Towel 4 Home 10 Y N N Stati
Uniti

A0006 Dog Food 16 Pet 22 N N N Stati
Uniti

A0007 Paint 43 Home 12 Y N N IN

Table 2

Item Number Nome Brand Popular Unit Price TTS

A0001 Milk Wholesome
Foods

Y 3 1

A0002 Eggs Dairy Love Y 4 1

A0003 Flower Spring Me Up! N 10 3

A0004 Tabella Woods Are Us N 50 10

A0005 Towel Claire Dane N 10 6

A0006 Dog Food Purina Y 22 3
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Item Number Nome Brand Popular Unit Price TTS

A0007 Paint Color the
World

N 12 2

1. Get the Merge Excel Sheets Example bot from the Bot Store.
The bot is automatically loaded to your Automation 360 On-Premises or Cloud environment.
You will receive an email with instructions for installing the bot in Automation 360 from the Bot Store.

2. Follow the instructions carefully. If you do not have the Bot Developer role assigned, contact your
administrator to add the role.

3. If your spreadsheets are not located at c:\bot_test\Spreadsheet1.xlsx and c:\bot_test
\Spreadsheet2.xlsx, update lines 5 and 9 of the bot with your desktop file location.

4. Run the TaskBot.
5. Update the TaskBot with any changes that reflect your use case, and make it your own.

You can also use the bot as a template for future Excel Advanced TaskBots by copying and saving it
with a new name.

Riferimenti correlati
Excel advanced package alla pagina 1533
Il package Excel advanced contiene actions che consentono di automatizzare molte delle attività ripetitive
quando si lavora con i fogli di calcolo di Microsoft Excel.

Esempio di migrazione dei dati da Excel a un database
In questo esempio, viene creato un bot per trasferire i valori da un foglio di calcolo Excel a un database
utilizzando actions da packages Database, Excel advanced e Loop.
Prima di iniziare a generare il tuo bot, crea quanto segue:
• Crea un foglio di calcolo Excel con i seguenti valori e salvalo (ad esempio: Test_migration_db.xlsx)

John Williams jwilliams@cmail.com

Sam Li sam.li@xyz.org

Carl Miller carl@carlmillerllc.com

© 2023 Automation Anywhere. All rights reserved.     2068

https://botstore.automationanywhere.com/bot/a2019-merge-excel-sheets-example/


    Automation Anywhere - Crea

• Accedi alla tabella del database denominata CustomerT con le seguenti colonne: (Crea un database
simile all'immagine sottostante e salvalo - ad esempio: salvalo come Test_Migration_db.accdb)
• Nome
• Cognome
• E-mail

Per eseguire la migrazione dei valori da un foglio di calcolo a una tabella in un database, attieniti alla
seguente procedura:
1. Create a new bot:

a) Nel pannello di sinistra, fai clic su Automazione.
b) Fai clic su Crea nuovo > Bot.
c) In the Create Task Bot window, enter the bot name.
d) Accept the default folder location: \Bots\

To change the default bot storage location, click Choose and follow the prompts.
e) Fai clic su Crea e modifica.
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2. Apri il foglio di calcolo:
a) Fai doppio clic o trascina the l'action Excel avanzato > Apri.
b) Fai clic su Sfoglia per specificare il percorso del file.

c) Seleziona l'opzione per aprire il file in lettura-scrittura.
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3. Esegui la connessione al database:
a) Fai doppio clic o trascina l'action Database > Connetti.
b) Seleziona la modalità di connessione definita dall'utente.

c) Seleziona il tipo di database Microsoft Access.
d) Fai clic su Sfoglia per specificare il percorso del file.
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4. Inserisci i valori Excel nel database, riga per riga:
a) Fai doppio clic o trascina l'action Loop.
b) Seleziona l'iteratore Excel avanzato > Per ogni riga nel foglio di lavoro.
c) Seleziona Tutte le righe dal menu a discesa Loop tramite.

d) In Assegna il valore corrente a questa variabile, crea la variabile record rExcelCurrentRow.
e) Trascina l'action Database > Inserisci/aggiorna/elimina nel container Loop.
f) Immetti la seguente istruzione SQL:

INSERT INTO CustomerT (FirstName,LastName,Email) values
 ('$rExcelCurrentRow[0]$','$rExcelCurrentRow[1]$','$rExcelCurrentRow[2]$');
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5. Esegui la disconnessione dal database. Trascina l'action Database > Disconnetti sotto al container
Loop.

6. Chiudi il foglio di calcolo. Fai doppio clic o trascina l'action Excel avanzato > Chiudi foglio di
calcolo.

7. Fai clic su Salva.

Riferimenti correlati
Database package alla pagina 1449
I database supportano le operazioni interne di un'azienda mediante la memorizzazione di una varietà di
dati, quali transazioni di vendita, cataloghi dei prodotti, inventari e profili dei clienti. Use the Database
package to connect to a database, begin a transaction, and manipulate the stored data by retrieving,
inserting, updating, deleting, and exporting it to a CSV file.
Excel advanced package alla pagina 1533
Il package Excel advanced contiene actions che consentono di automatizzare molte delle attività ripetitive
quando si lavora con i fogli di calcolo di Microsoft Excel.
Loop package alla pagina 1681
Utilizza il Loop Pacchetto per eseguire una sequenza di actions ripetutamente per un numero specifico di
volte o fin quando una condizione specifica non sarà soddisfatta.
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Example of using the Run action
The Run action from the TaskBot package enables you to run and pass values to one or more child bots.
In this example, you use the Run action to pass two values from a parent bot to the child bot; the child
bot adds the values and passes the sum back to the parent bot.
This example demonstrates the following:

Modularization Modularization separates a TaskBot into several
bots, where each bot is built with all the actions
necessary to perform one specific function of the
greater task.
In this example, you build a single child bot to add
the values. You can build several child bots, with
each performing a different mathematical operation,
and edit the parent bot to call whichever one you
want to use.

Reusability Reusability enables the user to build a bot once,
and then use that bot to automate many processes.
The child bot contains only the actions necessary to
add the values and print them to a Message Box.
Also, the bot adds two variables instead of hard-
coded values. As a result, this bot can be reused for
any task that involves an addition operation.

Data control Because the child bot accepts and returns values
only through the use of variables, it does not hold
data. This minimizes the chance of data leakage.

To run a TaskBot from the current task, perform these steps:
Build the child bot.
1. Apri un nuovo bot.

a) Nel pannello di sinistra, fai clic su Automazione.
Viene visualizzato un elenco di bot e moduli disponibili.

b) Fai clic su Crea un bot.
c) Enter the bot name AddChildBot.
d) Immetti il percorso della cartella Bots\TaskBotExample.

Per cambiare la posizione in cui viene memorizzato il bot, fai clic su Scegli e segui i prompt.
e) Fai clic su Crea e Modifica.

2. Create the following variables:
• v1: number type; use as input
• v2: number type; use as input
• nSum: number type
• sSum: string type; use as output

Create a variable alla pagina 2030

© 2023 Automation Anywhere. All rights reserved.     2074



    Automation Anywhere - Crea

3. Use a Number > Assign action to perform the mathematical operation.
a) Double-click or drag the Number > Assign action.
b) In the Select the source string variable/ value field, enter the following expression: $v1$ +

 $v2$

c) Select nSum from the Select destination number variable list.

4. Use the Number > To string action to convert the value so it can be printed to a Message Box.
a) Double-click or drag the Number > To string action.
b) In the Enter a number field, enter the following expression: $nSum$
c) Select sSum from the Assign output to variable list.

5. Fai clic su Salva.
6. Fai clic su Chiudi.
Crea il bot padre.
7. Apri un nuovo bot.

a) On the left panel, click Automation
Viene visualizzato un elenco di bot e moduli disponibili.

b) Fai clic su Crea un bot.
c) Enter the bot name MathBot.
d) Enter the folder location \Bots\TaskBotExample.

Per cambiare la posizione in cui viene memorizzato il bot, fai clic su Scegli e segui i prompt.
e) Fai clic su Crea e Modifica.

8. Create a Dictionary variable of Any subtype named dSums to accept the values passed from the child
bot.
Use the Any subtype to enable the parent bot to accept String, Number, or Boolean type values.

9. Insert a Task Bot > Run action to specify the values for the mathematical operation and the output
variable to hold the sum.
a) Fai doppio clic o trascina l'action TaskBot > Esegui.
b) Click Browse to navigate to Bots\TaskBotExample\AddChildBot.
c) Enter the following values in the Input values fields:

• v1: 12
• v2: 54

d) Select dSums from the Assign output to variable list.

Nota:  Use a Dictionary variable to hold the output of the Run action in order to make the parent
bot more versatile. This way a parent bot can handle different child bots regardless of whether
they return a single value or several values.
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10. Use a Message Box to retrieve and print the sum.
The variable sSum retrieved from the child bot is a key in the Dictionary variable dSums.

Nota:  You must know the variable names from the child bot to extract them from the parent bot. The
interface does not automatically import the variable names to the parent bot.

a) Fai doppio clic su o trascina l'action Finestra di messaggio.
b) Enter $dSums{sSum}$ in the Message to display field.

11. Fai clic su Salva.
12. Fai clic su Esegui.

The bot runs and the Message Box appears containing the sum 66.

Riferimenti correlati
Task Bot package alla pagina 1895
Utilizza Esegui, Pausa e Sospendi actions nel package Task Bot per gestire l'esecuzione di uno o più
bots figlio da un bot padre o con un software di terze parti utilizzando un'API.
Message box package alla pagina 1690
Use the Message box action from the Message box package to insert a message box that shows a
message when the task runs. For example, you can insert a Message Box action to follow a web form so
that the action displays the message: Web Form Filled and Complete.

Esempio di utilizzo dell'azione Servizio Web SOAP
Utilizza l'action Servizio Web SOAP per passare due valori numerici e restituire la somma da
un'applicazione di calcolo online.
Per richiamare i Servizi Web SOAP, procedi come segue:
1. Fai doppio clic o trascina l'azione Servizi Web SOAP.
2. Seleziona un metodo di connessione:

• To connect using a URI, enter the URI, for example, http://www.dneonline.com/
calculator.asmx?WSDL.

• Per connetterti utilizzando un file, seleziona un file dalla Control Room o dal desktop, oppure
inserisci una variabile.

3. Opzionale: Inserisci l'endpoint SOAP nel campo Posizione indirizzo.
Specificando la posizione dell'indirizzo, il bot la utilizzerà durante l'esecuzione; altrimenti, il bot
utilizzerà la posizione dell'indirizzo ottenuta dal file WSDL.

Nota:  Se si sta creando l'URI SOAP manualmente e non si utilizza l'opzione Crea una richiesta
SOAP, vai al passaggio 6 alla pagina 2077.

4. Fai clic su Crea una richiesta SOAP.
Si apre la finestra Richiesta SOAP che visualizza i servizi e le porte, con dettagli sulle loro operazioni
e sui parametri.

5. Nella finestra Richiesta SOAP, espandi il servizio per il quale desideri visualizzare l'elenco delle porte.
Fai clic sulla porta richiesta per visualizzare l'elenco delle operazioni disponibili. Seleziona l'operazione
richiesta e fai clic su Applica per recuperare i dettagli dell'operazione dalla richiesta SOAP.
Se si utilizza l'opzione Crea una richiesta SOAP, i campi Servizi, Porta, Operazione e Parametri
dell'operazione sono automaticamente popolati con dettagli basati sull'operazione selezionata. Vai al
passaggio 10 alla pagina 2077.
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6. Nel campo Servizio, immetti il nome del servizio.
Questo campo identifica l'insieme di porte supportate dal servizio Web. Contiene il@valore nome
del servizioper una chiamata del servizio Web SOAP, ad esempio Calcolatrice.

7. Opzionale: Nel campo Porta, immetti l'endpoint con cui connettersi.
Se non si specifica una porta, il bot userà la prima porta menzionata nel file WSDL in base al servizio
selezionato. Tuttavia, se quella porta non è supportata dal servizio Web SOAP, l'esecuzione del bot non
riuscirà.
Questo campo contiene il@nome vincolanteper una chiamata del servizio Web SOAP, ad esempio
CalcolatriceSoap.

8. Seleziona la versione SOAP dell'endpoint specificato nel campo Porta.
Scegli 1.1 o 1.2.

9. Nel campo Operazione, immetti il nome della funzione di servizio per l'endpoint specificato nel campo
Porta.
L'esecuzione del bot non riesce se una delle seguenti affermazioni è vera:
• La porta menzionata nel campo Porta non ha operazioni.
• L'operazione menzionata nella richiesta SOAP per la porta non è disponibile.

Questo campo contiene il@nome dell'operazioneper una chiamata del servizio Web SOAP, ad
esempio Aggiungi.

10. Seleziona Parametri operazione o Parametri dati non elaborati per fornire i dettagli del
parametro.

Nota:  Se hai selezionato Crea una richiesta SOAP, la tabella dei dettagli dei parametri nella
scheda Operazione viene automaticamente popolata con i parametri dell'operazione selezionata.
Fornisci i valori per questi parametri. Puoi anche aggiungere, modificare o eliminare i parametri per
una particolare operazione.

• Se selezioni Parametri operazione, immetti il nome e il valore di ciascun parametro. Ad esempio,
immetti i seguenti valori:
a. intA nel primo campo Nome
b. 10 nel primo campo Valore
c. intB nel secondo campo Nome
d. 20 nel secondo campo Valore

• Se scegli Parametri dati non elaborati, seleziona Parametri o Parametri di credenziali.

11. Parametri: È possibile utilizzare i valori delle credenziali dall'armadietto delle credenziali senza
esporre le credenziali (nome utente o password) in chiaro nei dati non elaborati. Per farlo, devi prima
mappare la credenziale nel mapper di credenziali e usare il nome di riferimento nei dati non elaborati
tra parentesi graffe.
Ad esempio, nei dati non elaborati hai fornito la password in chiaro per autenticarti sul server.

<aut:AuthHeader>
<aut:Password> abc@123</aut:Password>
</aut:AuthHeader>

Per usare la password dell'armadietto delle credenziali, esegui i passaggi seguenti:
a) Fai clic su Aggiungi sostituzione.

Immetti il nome di riferimento, ad esempio pwd nel campo Nome in XML. Seleziona
Credenziale per utilizzare un valore disponibile nel Credential Vault o seleziona Variabile per
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utilizzare una variabile credenziale o Stringa non sicura per specificare manualmente il valore
che vuoi usare.
Per maggiori informazioni sui credential vault e su come usarli, vedi Credentials and lockers in the
Credential Vault alla pagina 2839.

b) Fai clic su Aggiungi
c) Specifica il riferimento nei dati non elaborati all'interno di parentesi graffe come segue:

<aut:AuthHeader>
<aut:Password>{{pwd}}</aut:Password>
</aut:AuthHeader>

The reference name pwd specified in raw data will substitute the corresponding value stored in
the credential vault.
Assicurati di immettere il nome di riferimento nello stesso formato specificato in Aggiungi
sostituzione. For example, if you have entered password as pwd in Add substitution and enter
password as reference name in the raw data, when you run the bot, the bot will encounter an
error.

12. Parametri di credenziali: se desideri inserire parametri di dati non elaborati come credenziali. Puoi
scegliere Credenziale per usare un valore disponibile nel Credential Vault o selezionare Variabile per
usare una variabile credenziale o una stringa non sicura per specificare manualmente il valore che vuoi
utilizzare.

13. Seleziona Nessuna autenticazione o Base dall'elenco Modalità di autenticazione.
• Se selezioni Nessuna autenticazione, vai al passaggio successivo.
• Se selezioni Base, immetti le tue credenziali.

14. Opzionale: Fornisci un certificato Client selezionando un file dalla Control Room o dal desktop oppure
immetti una variabile.

15. Opzionale: Fornisci intestazioni personalizzate.
16. Opzionale: Fornisci un file per salvare l'output XML.
17. Seleziona Risposta completa o Risposta selezionata per restringere l'ambito della risposta.

• Se selezioni Risposta completa, vai al passaggio successivo.
• Se selezioni Risposta selezionata, esegui i passaggi seguenti, se stai creando l'espressione Xpath

manualmente e non utilizzi l'opzione Crea Xpath.
a. Fornisci l'espressione XPath. Ad esempio:

/*[local-name()='Envelope' and namespace-uri()='http://
schemas.xmlsoap.org/soap/envelope/']/*[local-name()='Body' and
 namespace-uri()='http://schemas.xmlsoap.org/soap/envelope/']/
*[local-name()='AddResponse' and namespace-uri()='http://
tempuri.org/']/*[local-name()='AddResult' and namespace-
uri()='http://tempuri.org/']

b. seleziona una sezione dell'output XML: Valori, XML interno o XML esterno.
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c. If you select the option Values, choose return content as: String delimited by or List of
strings.
• If you select String delimited by, choose a delimiter option: Barra verticale, Punto e

virgola o Personalizzazione.
Se selezioni Personalizzazione, inserisci le variabili o i caratteri nel campo (opzionale)
Delimitatore personalizzato.

Nota:  Il carattere speciale del segno del dollaro ($) come delimitatore non è supportato.

• Select List of strings to return the output of the soap response as list of strings.

Nota:  You can only specify a list type of variable with data type as strings.

18. Fai clic su Crea Xpath.
Appare la finestra Anteprima di output.

19. Seleziona il nodo appropriato dal corpo della risposta. Il percorso XML viene creato automaticamente.
Fai clic su Applica.
Se si utilizza l'opzione Crea Xpath, i campi Espressione XPath e Valore sono automaticamente
popolati con dettagli basati sull'operazione selezionata.

20. Opzionale: Per impostare un valore di timeout quando invii una richiesta SOAP e ricevi una risposta,
nel campo Attendi il completamento dell'azione specifica il tempo di attesa (in millisecondi).
Per impostazione predefinita, il tempo di attesa è di 60.000 millisecondi.

21. Configure the P12 certificate:
• To get the SSL certification file, select one of the following options: Control Room file, Desktop

file, or Variable
• Configure the Keystore properties:

• Keystore file (Optional): To provide the keystore file in. p12 format, select one of the
following options: Control Room file, Desktop file, or Variable. The keystore file includes
the client's private key and certificate.

• Keystore password (Optional): To provide the password for the keystore file, select one of
the following options: Credential, Variable , or Insecure string. The password is used to
access the keystore file.

22. Seleziona una variabile per memorizzare l'output XML.
For example, prompt-assignment

23. Verify the output of the SOAP web service action by inserting a Message box action with the
variable prompt-assignment in the body message.
Quando esegui il bot, la finestra di messaggio dovrebbe mostrare 30.

Riferimenti correlati
SOAP Web Service package alla pagina 1880
Use the SOAP web service action from the SOAP Web Service package to access and exchange
information between two systems in XML format.

Example of using Get structure command from SAP BAPI package
Using the SAP BAPI package, build a bot that inputs a structure to get data.
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Download the SAP Java connector and DLL from the SAP website.
In this tutorial, you will build a  that invokes BAPI_FLIGHT_GETLIST from the SAP demo Flight Data
application. When executed, the  calls the BAPI function by inputting an airline ID and destination details,
gets a list of flights, and writes the response data to a CSV file.
You will use the following import parameters to limit your search:
• AIRLINE: Use the parameter to pass the airline ID.
• DESTINATION_FROM: Use the parameter to get the structure and pass the city name and airport ID.

The tutorial is intended to demonstrate how to perform the following actions:
• Get the structure of an import parameter.
• Set the values for the fields in the retrieved structure.
• Get response data in a table based on the input data.

1. Create a TaskBot named SAP-BAPI-FlightListReport.
a) Accedi a Control Room.
b) Nel pannello di sinistra, fai clic su Automazione.
c) Click the Create a bot icon.
d) In the Name field, enter SAP-BAPI-FlightListReport, and click Create & Edit.

2. To connect the  to your SAP system, from the Actions panel, find SAP BAPI > Connect action and
add it to the .
a) In JCo: SAP Java Connector package, specify the path to the Java connector .jar file.
b) In JCo DLL dependency, specify the path to the DLL file.
c) Choose Custom Application Server as Connection Type.
d) In Application server host name, specify the host name of the SAP application server.

Nota:  As a best practice, use the  to specify sensitive information such as host name, user
name, and password.

e) In System number, enter the instance number.
f) In SAP instance system ID, enter the system ID.
g) In Client number, enter the client number.
h) In Logon language code, enter EN or the language specific to your system.
i) In Router string, enter the SAP router string.
j) In Username, enter your SAP user name.
k) In Password, enter your password.
l) Run the  to test the connection.

If the specified connection properties are correct, the bot is executed successfully.

3. To create a function, add the SAP BAPI > Create function action.
a) In Function alias name, enter getFlightListByAirline.
b) In BAPI name, enter BAPI_FLIGHT_GETLIST.
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4. To filter the data by an airline name, add the SAP BAPI > Set field value action.
a) In Function alias name, enter getFlightListByAirline.
b) Click the Function tab.
c) In Field name, enter AIRLINE as the input parameter name.
d) In Field value, enter AZ.

5. To limit the selection by the airport and the destination city, get the structure of the
DESTINATION_FROM import parameter first, and then set values for the fields in the retrieved
structure. To do this, add the SAP BAPI > Get structure action.
a) In Function alias name, enter getFlightListByAirline.
b) In Structure name, enter DESTINATION_FROM.
c) To assign the retrieved structure to an alias, click the Alias tab in Destination, and enter

destinationFrom in Create structure alias.
You can now use the alias to set values for the fields in the retrieved structure.

6. To set a value for the AIRPORT ID field in the DESTINATION_FROM parameter, add the SAP BAPI >
Set field value action.
a) In Function alias name, enter getFlightListByAirline.
b) In Source, click the Structure tab.
c) In Structure alias, enter destinationFrom.
d) In Field name, enter AIRPORTID.
e) In Field value, enter FCO.

7. To set a value for the CITY field in the DESTINATION_FROM parameter, add the SAP BAPI > Set
field value action.
a) In Function alias name, enter getFlightListByAirline.
b) In Source, click the Structure tab.
c) In Structure alias, enter destinationFrom.
d) In Field name, enter CITY.
e) In Field value, enter ROME.

8. To execute BAPI_FLIGHT_GETLIST, add the SAP BAPI > Run function action.
a) In Function alias name, enter getFlightListByAirline.

9. To get the filtered data from the FLIGHT_LIST table, add the SAP BAPI > Get table action.
a) In Function alias name, enter getFlightListByAirline.
b) In Table name, click the FLIGHT_LIST tab.
c) In Destination, click Variable to store the retrieved table data in memory.
d) In Save the outcome to a variable, create a variable named tblFlightList by clicking (x).
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10. To write the data from the retrieved table to a CSV file, add the Data Table > Write to file action.
a) In Data table, select tblFlightList.
b) In Enter file name, specify the path to the CSV file to which you want to write the data.
c) Select Create folders/files if it doesn't exist.
d) Click Overwrite existing file.

11. Save and then run the bot.

Example of writing data to SAP using SAP BAPI package
Using the SAP BAPI package, build a bot that writes data to the SAP database.
Download the SAP Java connector and DLL from the SAP website.
In this tutorial, you will build a  that invokes BAPI_FLCUST_CREATEFROMDATA from the SAP demo Flight
Data application. You will use the CUSTOMER_DATA import parameter to pass the customer data to the
BAPI. When executed, the  creates a new customer record in SAP database and displays the customer
number returned by the BAPI.
The tutorial demonstrates how to perform the following actions:
• Use the Get structure command to set values for the import parameters.
• Create a new record in an SAP table.
• Receive a response from a BAPI.

1. Create a bot named SAP-BAPI-CreateNewFlightCustomer.
a) Accedi a Control Room.
b) Nel pannello di sinistra, fai clic su Automazione.
c) Click the Create a bot icon.
d) In the Name field, enter SAP-BAPI-CreateNewFlightCustomer, and click Create & Edit.
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2. To connect the  to your SAP system, from the Actions panel, find SAP BAPI > Connect action and
add it to the .
a) In JCo: SAP Java Connector package, specify the path to the Java connector .jar file.
b) In JCo DLL dependency, specify the path to the DLL file.
c) Choose Custom Application Server as Connection Type.
d) In Application server host name, specify the host name of the SAP application server.

Nota:  As a best practice, use the  to specify sensitive information such as host name, user
name, and password.

e) In System number, enter the instance number.
f) In SAP instance system ID, enter the system ID.
g) In Client number, enter the client number.
h) In Logon language code, enter EN or the language specific to your system.
i) In Router string, enter the SAP router string.
j) In Username, enter your SAP user name.
k) In Password, enter your password.
l) Run the  to test the connection.

If the specified connection properties are correct, the bot is executed successfully.

3. To create a function, add the SAP BAPI > Create function action.
a) In Function alias name, enter createNewFlightCustomer.
b) In BAPI name, enter BAPI_FLCUST_CREATEFROMDATA.

4. Because the CUSTOMER_DATA parameter is of the type structure, get the structure of the import
parameter and assign it to an alias. To do this, add the SAP BAPI > Get structure action.
a) In Function alias name, enter createNewFlightCustomer.
b) In Structure name, enter CUSTOMER_DATA.
c) To store the retrieved structure as an alias, click the Alias tab in Destination.
d) In Create structure alias, enter CustomerData.

You will use the alias to set values for the import field within the retrieved structure.

5. To set the value for the CUSTNAME field, add the SAP BAPI > Set field value action.
a) In Function alias name, enter createNewFlightCustomer.
b) In Source, click the Structure tab.
c) In Structure alias, enter CustomerData.
d) In Field name, enter CUSTNAME.
e) In Field value, enter John Doe.

6. Repeat Step 5 to add and configure the Set field value action for each of the following fields:

Nome campo Valore del campo

STREET testStreet

POSTCODE 101001
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Nome campo Valore del campo

CITY testCity

COUNTR US

COUNTR 00000000

EMAIL test@example.com

CUSTTYPE P

7. To execute BAPI_FLCUST_CREATEFROMDATA, add the SAP BAPI > Run function action.
a) In Function alias name, enter createNewFlightCustomer.

Nota:  If you want BAPI_FLCUST_CREATEFROMDATA to write the data to SAP database, you must
select the End sequence and the Commit transaction options. If you select the End sequence
option, ensure that you select the Begin sequence option in the Create function action.
The sample bot created with the help of this tutorial is intended to demonstrate how the Create()
BAPIs work when the SAP BAPI package is used. It is not intended to modify the database.

The BAPI assigns and returns a customer number after a new customer record is created.
8. To get the number into a variable, add the SAP BAPI > Get field value action.

a) In Function alias name, enter createNewFlightCustomer.
b) In Source, click the Function tab.
c) In Field name, enter CUSTOMERNUMBER
d) In Save the outcome to a variable, create a variable named strCustomerNumber by clicking

(x) and select the variable.

9. To display the customer number, add the Message Box action.
a) In Enter the message to display, select the strCustomerNumber variable.

10. Save and run the bot.

Example of using Run standard workflow from SAP BAPI package
Using the Run standard workflow action from the SAP BAPI package, build a bot that retrieves data from
SAP systems.
Download the SAP Java connector and DLL from the SAP website.
In this tutorial, you will build a bot that uses the Run standard workflow action. The Run standard
workflow action provides a user interface that enables you to select BAPIs and configure the parameters
for the selected BAPI.
By using this single SAP BAPI package action, you will perform the following actions:
• Select a BAPI (BAPI_FLIGHT_CHECKAVAILABILITY) from a list of function modules available in the

connected SAP system.
• Set values for the import and export parameters of the selected BAPI.
• Assign retrieved structure or tables to dictionary or table variables.
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When executed, the bot gets flight availability data based on the input data, and writes it to a CSV file.
1. Create a bot named SAP-BAPI-CheckFlightAvailability.

a) Accedi a Control Room.
b) Nel pannello di sinistra, fai clic su Automazione.
c) Click the Create a bot icon.
d) In the Name field, enter SAP-BAPI-CheckFlightAvailability, and click Create & Edit.

2. To connect the  to your SAP system, from the Actions panel, find SAP BAPI > Connect action and
add it to the .
a) In JCo: SAP Java Connector package, specify the path to the Java connector .jar file.
b) In JCo DLL dependency, specify the path to the DLL file.
c) Choose Custom Application Server as Connection Type.
d) In Application server host name, specify the host name of the SAP application server.

Nota:  As a best practice, use the  to specify sensitive information such as host name, user
name, and password.

e) In System number, enter the instance number.
f) In SAP instance system ID, enter the system ID.
g) In Client number, enter the client number.
h) In Logon language code, enter EN or the language specific to your system.
i) In Router string, enter the SAP router string.
j) In Username, enter your SAP user name.
k) In Password, enter your password.
l) Run the  to test the connection.

If the specified connection properties are correct, the bot is executed successfully.

3. From the Actions panel, find SAP BAPI > Run standard workflow action after the Connect
action.

4. Select a BAPI.
a) Click the Select workflow option.
b) In the Standard BAPI Selector window, from Select Standard BAPI, expand SAP Modules.
c) Find and expand Flight with connection data (SAP training).
d) In Flight with connection data (SAP training), expand General > Create, select

BAPI_FLIGHT_CHECKAVAILABILITY, and then click Select.
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5. Specify values for the fields in the import parameter. Do the following in Import to BAPI:
a) Click the vertical ellipsis option for the AIRLINEID field, and select Edit.
b) In Value, enter DL and click Apply.
c) Click the vertical ellipsis option for the CONNECTIONID field, and select Edit.
d) In Value, enter 1699 and click Apply.
e) Click the vertical ellipsis option for the FLIGHTDATE field, and select Edit.
f) In Value, enter 20170418 and click Apply.

The Java connector for SAP systems takes the date values in the yyyymmdd format.

BAPI_FLIGHT_CHECKAVAILABILITY returns data in the AVAILABILITY export parameter, which is
of the type structure.

6. In Export to BAPI, perform the following steps:
a) Click the ellipsis option for the AVAILABILITY field.
b) On the Availability window, select the Field name check box to select all fields within the

structure, and then click Apply.

7. Store the data that the BAPI exports to a variable.
a) In Save exported structures and scalars, create a variable by clicking (x) and name it

ReturnStructure.

8. In Save exported structures and scalars, create a variable by clicking (x) and name it
ReturnStructure.

9. Save the Run standard workflow action.
10. Convert the exported data to a table.

a) From the Actions panel, find Dictionary > Get action, and add it after the Run standard
workflow action.

b) Click inside Dictionary variable and select ReturnStructure.
c) In Key, enter AVAILABILITY.
d) In Assign the output to variable, create a variable by clicking (x) and name it Availability.

11. To write the data from the retrieved table to a CSV file, add the Data Table > Write to file action.
a) In Data table, select Availability.
b) In Enter file name, specify the path to the CSV file, to which you want to write the data.
c) Select Create folders/files if it doesn't exist.
d) Click Overwrite existing file.

12. Save and run the bot.

Example of using the VBScript package in a resilient bot
Build a bot that executes a Microsoft Visual Basic script. Use the Try/Catch package to gracefully end the
bot if it fails, making it resilient to crashes. A resilient bot allows scheduled and queued bots to continue
even if the current bot encounters an error.
In this bot, you ask the user to provide a number. The bot passes the number to a Microsoft Visual Basic
script to multiply by pi and return the value. The bot then reports the result to the user. You can use the
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VBScript action to either import an external script or type it directly into your bot. In this example, you
manually type the script. You also add resiliency to the bot by adding error handling.
1. Create a bot:

a) Nel pannello di sinistra, fai clic su Automazione.
Viene visualizzato un elenco di bot e moduli disponibili.

b) Fai clic su Crea nuovo > bot.
c) Provide a name for the bot: MultiplyPi
d) Immetti la posizione della cartella: Bots\TaskBotExample
e) Fai clic su Crea e Modifica.

2. Create a variable: nPromptAnswer:
• Type: Numero
• Name: nPromptAnswer

Create a variable alla pagina 2030
3. Create a variable: lNumbersForPi:

• Type: Elenco
• Subtype: Numero
• Name: lNumbersForPi

4. Fai clic su Salva.
5. Use the Prompt > For value action to ask the user for a number.

a) Click the Show link on the Actions pane.
b) Double-click or drag the Prompt For value action to add it to the bot.
c) In the Prompt window caption field, type: Any Number
d) In the Prompt message field, type: Enter any number to multiply by pi.
e) In the Assign the value to a variable field, select prompt-assignment.

6. Fai clic su Salva.
7. Use the Error handler > Try action to gracefully end the bot if there was an error, such as the user

not entering a number.
a) Double-click or drag the Error handler > Try action.
b) Drag the Prompt > For value action under the Error handler > Try action.

8. Fai clic su Salva.
9. Convert the prompt-assignment (string) to a number value.

a) Double-click or drag the String > To number action, adding it as the last line before the Error
handler: Catch action.

b) In the Enter the string field, press F2 to open the list of your variables, and select prompt-
assignment.

c) Click Yes, insert.
d) In the Assign the output to variable field, select nPromptAnswer.

10. Fai clic su Salva.
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11. Copy the number value to the first item in the list of numbers to pass to VBScript.
a) Double-click or drag the List > Add item action, adding it as the last line before the Error

handler: Catch action.
b) In the List variable field, select lNumbersForPi.
c) In the Item to be added field, select nPromptAnswer.

12. Fai clic su Salva.
13. Use the VBScript > Open action to provide your Visual Basic source code.

a) Double-click or drag the VBScript Open action, adding it as the last line before the Error
handler: Catch action.

b) In the VBScript options, select Manual Input.
c) Copy the following code and paste it into the Enter script here field:

Dim Arg, var1, var2
Set Arg = WScript.Arguments
Function MultiplyPi(Arg)
  var1 = Arg(0)
  var2 = 3.14159
  MultiplyPi = cdbl(var1)*var2
End Function

14. Fai clic su Salva.
15. Use the VBScript > Run function action to execute the script.

a) Double-click or drag the VBScript Run function action, adding it as the last line before the
Error handler: Catch action.

b) In the Enter the name of the function to be executed (optional) type MultiplyPi.
c) In the Parameters (optional) field, select lNumbersForPi variable.
d) In the Assign the output to variable (optional) field, select prompt-assignment.

16. Fai clic su Salva.
17. Use the VBScript > Close action to end the session.

a) Double-click or drag the VBScript Close action, adding it as the last line before the Error
handler: Catch action.

18. Fai clic su Salva.
19. Print the answer generated in the VBScript on the screen.

a) Double-click or drag the Message box action, adding it as the last line before the Error
handler: Catch action.

b) In the Enter the message to display field, type Pi times your number is: , then press
F2 to open the list of your variables. Select prompt-assignment.

c) Click Yes, insert.

20. Fai clic su Salva.
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21. Notify the user if an error occurred and end the bot gracefully.
a) Click the Error handler: Catch AllErrors action once so that it is highlighted in your bot.
b) Double-click or drag the Message boxaction to insert it as the last bot action.
c) In the Enter the message to display field, type Bot failed. Please be sure to

 enter only numbers..

22. Fai clic su Salva.
23. Click the List tab to view your code as text only.

Your code should look like this:

Start
Error handler: Try
    Prompt: For value during bot execution and assign the value $prompt-
assignment$
    String: To number Convert string $prompt-assignment$ to a number and
 assign it to number variable $nPromptAnswer$
    List: Add item $nPromptAnswer$ to $lNumbersForPi$
    VBScript: Open VBScript manual script of 7 lines
    VBScript: Run function "MultiplyPi"
    VBScript: Close VBScript "Default"
    Message box "Pi times your number is: $prompt-assignment$"
Error handler: Catch AllErrors
    Message box "Bot failed.  Please be sure to enter only numbers."
End

24. Esegui il tuo bot.
25. When the bot runs successfully, a message box displays the calculated number. View the message

and click Close. You can test the resiliency of your bot by running the bot again and entering a letter
instead of a number.

Riferimenti correlati
VBScript package alla pagina 1921
Il package VBScript contiene actions che abilitano le funzioni VBScript in un'attività.

Build a Bot Insight dashboard bot
In this example, you build a bot that retrieves data from a website to create visualizations in Bot Insight.
Configure an empty string variable named sNull.
Create a variable alla pagina 2030
1. Create a new bot:

a) Nel pannello di sinistra, fai clic su Automazione.
b) Fai clic su Crea nuovo > Bot.
c) In the Create Task Bot window, enter the bot name.
d) Accept the default folder location: \Bots\

To change the default bot storage location, click Choose and follow the prompts.
e) Fai clic su Crea e modifica.
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2. Open a browser window to the web page from which you want to extract the table.
a) Double-click or drag the Browser > Launch website action.
b) In the URL field, enter https://www.statista.com/statistics/183483/ranking-of-

languages-spoken-at-home-in-the-us-in-2008/.
c) Select the Internet Explorer browser.

Nota:  Use Microsoft Internet Explorer because it reliably launches the website in a new window,
even if another window is already open. Other browsers might launch the website in a new tab if
there is an open window.

d) Fai clic su Salva.
e) Fai clic su Esegui.

The bot opens the window.

3. Select the table for extraction.
a) Fai doppio clic o trascina l'action Registratore > Acquisisci.
b) Click the Window tab and select the Languages spoken in the United States 2018 |

Statista window from the drop-down list.
Se il titolo della finestra non compare nell'elenco, fai clic su Aggiorna.

c) Fai clic su Acquisisci oggetto.
The Languages spoken in the United States 2018 | Statista window is activated.

d) Hover over the table until an orange box that surrounds the entire table appears.
e) Click the table.
f) Return to the Control Room.
g) In the Object properties table, verify the Control Type is TABLE.

In caso contrario, fai clic su Riacquisisci oggetto.
h) Dall'elenco a discesa Action, seleziona Ottieni tabella.
i) In the Assign output to variable field, create the tLanguages table variable.

4. Specify the file in which to save the data.
a) Fai doppio clic o trascina l'action Tabella dati > Scrivi su file.
b) From the Data table name list, select tLanguages.
c) Provide a file path to create a CSV file.

For example, C:\Users\<username>\Desktop\LanguagesTable.csv.
d) Select the Create folders/files if it doesn't exist option.
e) Select to overwrite the existing file.

5. Specify the file that holds the extracted data.
a) Fai doppio clic o trascina l'action CSV/TXT > Apri.
b) Provide the file path to the file specified in step 4.
c) Select the Contains header option to exclude the first row.
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6. Iterate though each row of the file.
a) Fai doppio clic o trascina l'action Loop.
b) Select the For each row in CSV/TXT iterator.
c) In the Assign the current row to this variable field, create the variable rCurrentRow.

7. Specify the data to populate the Bot Insight dashboard.
a) Double-click or drag the Analyze > Open action.
b) Double-click or drag the String > Assign action.
c) Enter $rCurrentRow[0]$ as the source string.

Press F2 to open the variables menu.
d) In the Select destination string variable field, create the variable sLanguage.
e) Double-click or drag the String > Replace action.

The extracted data uses commas to separate digits. You must remove the commas before you can
convert the string to a number data type to use in Bot Insight.

f) Enter $rCurrentRow[1]$ as the source string.
Press F2 to open the variables menu.

g) Enter , in the Find string field.
h) Select the Not a regular expression option.
i) In the Replace with field, enter $sNull$.
j) In the Assign the output row to variable field, create the variable sPopulation.
k) Double-click or drag the String > To number action.
l) Immetti la variabile $sPopulation$
m) In the Assign the output row to variable field, create the variable nPopulation.
n) Double-click or drag the Analyze > Close action.
o) Select the following variables:

• sLanguage
• nPopulation

8. Click Save and then Run.
9. Click Analyze.

The Bot Insight window appears.

Learn more about dashboards.
Dashboard di Bot Insight alla pagina 2956
Riferimenti correlati
Analyze package alla pagina 1392
Use the actions in the Analyze package to specify the actions and variables to use in the Bot Insight
dashboard and widgets. The Analyze package enables you to perform transactional analytics for the data
that is logged by the variables when the bot runs.
Browser package alla pagina 1425
Il Browser package contiene actions che consentono di scaricare file, trovare collegamenti interrotti
e avviare un sito Web. Questo package supporta i browser Google Chrome, Microsoft Edge basato su
Chromium e Internet Explorer.
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Pacchetto Recorder alla pagina 1751
Il package Registratore acquisisce una serie di compiti in un processo e poi li automatizza. Puoi
automatizzare le applicazioni aziendali (per esempio, applicazioni desktop, web, SAP e Java) usando
Recorder per acquisire le actions eseguite su oggetti dell'applicazione come una casella di testo, un
pulsante, una tabella, un pulsante di opzione, una casella combinata e una vista elenco.
Data Table package alla pagina 1439
Il package Data Table contiene actions che consentono di eseguire varie operazioni sui valori delle variabili
tabella. Use these actions to join or merge content, search for specific values, insert rows and columns,
remove duplicate rows, and write values to a file.
CSV/TXT package alla pagina 1436
The CSV/TXT package contains actions that enable you to open a CSV or text file, read data from that
file, and assign the data to a Table variable. This package supports files encoded in ANSI, Unicode, UTF-8,
or Windows-1251, and can process up to one million records.
Loop package alla pagina 1681
Utilizza il Loop Pacchetto per eseguire una sequenza di actions ripetutamente per un numero specifico di
volte o fin quando una condizione specifica non sarà soddisfatta.

Example of using multiple analyze actions in a task
Build a bot that uses multiple Open and Close Analyze actions in a task to analyze and compare the sales
data for each quarter of XYZ Company, and create visualizations in Bot Insight.
Before you start building the bot, create the following data set on your desktop in the .csv file format.

PRODUCTCODEPRODUCTLINECOUNTRYQUANTITY
ORDERED
QTR1

SALES_QTR1QUANTITY
ORDERED
QTR2

SALES_QTR2QUANTITY
ORDERED
QTR3

SALES_QTR3QUANTITY
ORDERED
QTR4

SALES_QTR4

S18_1367Vintage
Cars

USA 39 4808.31 21 2856 50 5907.5 48 4389.12

S18_1367Vintage
Cars

Germania33 3288.78 42 2262.96 30 1746.6 25 2183.25

S18_1367Vintage
Cars

Francia 41 2055.74 42 4431.84 34 5375.4 45 2304.45

S18_1367Vintage
Cars

Australia 48 2354.88 33 3423.75 24 1496.64 32 1742.4

S18_1367Vintage
Cars

UK 30 5151 36 3081.24 33 4950.33 29 5176.5

S18_1367Vintage
Cars

India 50 3390 45 1702.8 23 4230.62 44 7554.8

S18_1367Vintage
Cars

Giappone28 1801.24 22 995.5 47 6034.33 33 5890.5

S18_1367Vintage
Cars

New
Zealand

43 4818.15 29 1716.22 42 3958.5 27 1879.74

S18_1367Vintage
Cars

Norvegia 39 4178.85 46 1528.58 34 3455.76 38 2323.7

S18_1367Vintage
Cars

Svezia 22 1903.22 - - 24 1685.28 23 1643.12
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PRODUCTCODEPRODUCTLINECOUNTRYQUANTITY
ORDERED
QTR1

SALES_QTR1QUANTITY
ORDERED
QTR2

SALES_QTR2QUANTITY
ORDERED
QTR3

SALES_QTR3QUANTITY
ORDERED
QTR4

SALES_QTR4

S18_1367Vintage
Cars

Spagna 50 2490.5 - - 29 1254.83 38 4299.7

S18_1367Vintage
Cars

Canada 49 1689.03 - - 36 1194.84 20 2212

S18_1367Vintage
Cars

Austria 26 2253.68 - - 49 2414.72 26 3206.32

1. Create a bot.
a) Log in to the Control Room as a Bot Creator.
b) Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei bots disponibili.
c) Fai clic su Crea nuovo > Bot.
d) Fai clic su Crea e modifica.

2. Open the XYZ sales data.csv file that you created.
a) Fai doppio clic o trascina l'action CSV/TXT > Apri.
b) In the Session name field, enter Session 1.
c) Provide the file path to XYZ company sales data.csv.
d) Select the Contains header option to exclude the first row.

3. Create a Record variable as Row by using the Create variable icon.
The Record variable holds all the values for one row. With each iteration of the loop, the bot retrieves
the values of the next row and stores them in the Record variable, overwriting the values from the
previous row.

4. To retrieve the values in the cells from each row in the XYZ company sales data.csv file, use a
Loop action.
a) Select For each row in CSV/TXT iterator.
b) In the Session name field, enter Session 1.
c) In the Assign the current row to this variable field, select the Row variable that you created.
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5. Create the following variables for four quarters by using the Create variable icon at the top of the
Variables menu.
• PRODUCTCODE
• PRODUCTLINE
• COUNTRY
• QUANTITYORDERED_QTR1
• SALES_QTR1
• QUANTITYORDERED_QTR2
• SALES_QTR2
• QUANTITYORDERED_QTR3
• SALES_QTR3
• QUANTITYORDERED_QTR4
• SALES_QTR4
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6. Specify the data to populate on the Bot Insight business dashboard.
a) Double-click or drag the Analyze > Open action.

Nota:  Ensure that you insert the Analyze Open and Close actions inside the Loop action to
analyze and capture the data from each row in the Bot Insight dashboard.

b) Double-click or drag the String > Assign action.
Press F2 to open the variables menu.

c) Choose the Row variable from the drop-down list.
d) Enter PRODUCTCODE and click Yes, insert.
e) In the Select destination string variable field, choose the PRODUCTCODE variable.

To assign string variables for PRODUCTLINE and COUNTRY, repeat Step 6b through Step 6e.
f) Double-click or drag the Number > Assign action.

Press F2 to open the variables menu.
g) Choose the row variable from the drop-down list.
h) Enter QUANTITYORDERED_QTR1 and click Yes, insert.
i) In the Select destination string variable field, choose the QUANTITYORDERED_QTR1

variable.
To assign number variables for SALES_QTR1, QUANTITYORDERED_QTR2, SALES_QTR2,
QUANTITYORDERED_QTR3, SALES_QTR3, QUANTITYORDERED_QTR4, and SALES_QTR4, repeat
Step 6f through Step 6i.

j) Double-click or drag the Analyze > Close action.
k) Enter the Transaction name as Quarters 1 and 2.
l) Select the following transactional variables in the Close action:

• PRODUCTCODE
• PRODUCTLINE
• COUNTRY
• QUANTITYORDERED_QTR1
• SALES_QTR1
• QUANTITYORDERED_QTR2
• SALES_QTR2

m) Double-click or drag the Analyze > Open action.
n) Double-click or drag the Analyze > Close action.
o) Enter the Transaction name as Quarters 3 and 4.
p) Select the following transactional variables in the Close action:

• PRODUCTCODE
• PRODUCTLINE
• COUNTRY
• QUANTITYORDERED_QTR3
• SALES_QTR3
• QUANTITYORDERED_QTR4
• SALES_QTR4

7. Click Save and then Run.
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8. Click Analyze Task Bot.
The Bot Insight business dashboard appears.

9. Select the Preview option.
The sales data is displayed as follows:

Example of updating default package version across bots
In this example, learn how to perform a bulk update of existing bots in the Control Room repository to use
the default version of the Excel advanced package.
To update bots to the default package version, ensure you have the View packages permission and the
permission to edit bots. When you update bots to the default package version, all the bots using the
Excel advanced package in the public workspace for which you have access will be updated to the default
version.
Consider the scenario where there are three versions of the Excel advanced package (5.0.0XXXXXXX,
 6.7.0XXXXXXX, and 6.8.0XXXXXXX), and the bots created initially are using the Excel default
version of 6.7.0XXXXXXX. The default Excel advanced version has to be changed to 6.8.0 XXXXXXX.
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In this example, you set the default package version to 6.8.0XXXXXXX so that all public repository bots
you have access to and which use the Excel advanced package are updated to use the default version
6.8.0 XXXXXXX.
1. To update all the bots in the public repository that use Excel advanced package to version

6.8.0XXXXXXX, perform these steps:
a) Navigate to Manage > Packages.
b) Search for and open the Excel advanced package.
c) On the package page, click the Version field and choose the version 6.8.0XXXXXXX.
d) Click Update bots to default version.
e) On the Update bots to default package version window that opens, enter the following

information:
• Nome attività: Update Package_Excel_MS_6.8.0.
• Descrizione: Bulk update of bots to set the default package version

 Excel_MS_6.8.0
• Commenti per l'archiviazione: Update the Excel advanced package version

 with default version 6.8.0.

f) Fai clic su Aggiorna bot.

The bots are checked out to set the package default version as 6.8.0XXXXXXX.
2. Naviga su Amministrazione > Log di audit.
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3. On the Audit log page, search by event type and choose the value Update default package.
You can view information about the start of the requested process, individual bots that are being
updated with the default package version, and the completion of the requested process.
a) Click the Update default package to bot requested item name and view the following

information:
• Nome della richiesta: UpdatePackage_Excel_MS_6.8.0 XXXXXXX
• What changed: Package version
• Nome pacchetto: Excel_MS
• Package version: 6.8.0XXXXXXX

You can view all the bots that are updated to use the default package version 6.8.0XXXXXXX.
b) Copy the Request ID , for example, b8bfa7bc58a784e4 from the Update default package

to bot requested page.
c) On the Audit log page, search by filter Request ID and enter the value b8bfa7bc58a784e4.

The Audit log page displays all the bots that are either successfully updated or those that failed
the update process. See the following example image:

d) Click any bot, for example, FineTune RoomDim037 to view the following details:
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• Nome pacchetto: Excel_MS
• Vecchia versione del pacchetto: 6.7.0XXXXXXX
• Versione del pacchetto di destinazione: 6.8.0XXXXXXX
• Vecchia versione del bot: 2
• Nuova versione del bot: 3

The bulk update process in this case takes approximately 13 minutes because the Control Room
has 500 bots to update.

e) Click the item name Update default package to bot completed to view the following details:
• Nome della richiesta: UpdatePackage_Excel_MS_6.8.0XXXXXXX.
• Successful bots: 500
• Unsuccessful bots: 0
• What changed: Package version
• Nome pacchetto: Excel_MS
• Vecchia versione del pacchetto: N/A

Example of using JSON package actions in a bot
Build a bot that runs a JSON script with multiple records. In this example, we use a JSON file that contains
a list of feeds from a blog, and the bot extracts the required information from the JSON file and prints it to
a message box.
To run JSON script from Automation 360, you must already have the JSON data stored either as a variable
or a file (.json, .txt format) on your desktop. The following screenshot displays the structure of a JSON
object as a sample.

{
    "feeds": [
 
        {
            "id": 1090,
            "title": "Amsterdam Beaches",
            "description": "It’s true that few people think of the
 Netherlands when planning a beach holiday. But whether you’re just visiting
 or lucky enough to call this iconic city home, there are plenty of great
 beaches to enjoy in Amsterdam",
            "location": "Kloveniersburgwal 1, 1012 CW Amsterdam,
 Netherlands",
            "lng": 0,
            "lat": 0,
            "userId": 3043,
            "name": "Ritu singh",
            "isdeleted": false,
            "profilePicture": "/Images/userimageicon.png",
            "videoUrl": null,
            "images": null,
            "mediatype": 0,
            "imagePaths": null,
            "feedsComment": null,
            "commentCount": 3,
            "multiMedia": [
                {
                    "id": 2157,
                    "name": "beach of amsterdam.PNG",
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                    "description": null,
                    "url": "feedsmedia/3043/c5522956-4ab5-408e-
b540-16a8c90af9b0.PNG",
                    "mediatype": 1,
                    "likeCount": 0,
                    "place": null,
                    "createAt": "0001-01-01T00:00:00"
                }
            ],
            "likeDislike": {
                "likes": 2,
                "dislikes": 1,
                "userAction": 2
            },
            "createdAt": "2019-12-26T07:08:38.4659686",
            "code": 0,
            "msg": null
        }
  ],
    "totalFeed": 125
}

1. Create a bot.
a) Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei bots disponibili.
b) Fai clic su Crea nuovo > bot.
c) Provide a name for the bot: JsonBot.
d) Fai clic su Crea e Modifica.

2. Start a JSON session by using the JSON > Start session action.
a) From the Actions pane, double-click or drag the JSON > Start session action.
b) In the Data Source field, choose File and select the Desktop file file type. Click Browse to

find your JSON file, for example, D:\userdefined\My Downloads\Sample Json with
 200 Records.json.

c) To create a JSON session, from Json object session, select Local session and enter Default
as the session name.

3. Create a variable: SampleString

• Tipo: String
• Name: SampleString

© 2023 Automation Anywhere. All rights reserved.     2100



    Automation Anywhere - Crea

4. Retrieve the value of the total number of feeds from the JSON script by using the JSON > Get node
value action.
a) From the Actions pane, double-click or drag the JSON > Get node value action.
b) In the JSON node key or path field, enter totalFeed.
c) In the Session name field, enter Default.
d) In the Save the outcome to a variable field, select SampleString.
e) To print the value of totalFeed, double-click or drag the Message box action.
f) To open the list of your variables, in the Enter the message to display field, press F2, and then

select SampleString.
g) Click Yes, insert.

5. To retrieve any specific value from 125 feeds, perform the following steps.
a) From the Actions pane, double-click or drag the JSON > Get node value action.
b) In the JSON node key or path field, enter feeds[52].title.
c) In the Session name field, enter Default.
d) In the Save the outcome to a variable field, select SampleString.
e) To print the value of feeds[52].title, double-click or drag the Message box action.
f) To open the list of your variables, in the Enter the message to display field, press F2, and then

select SampleString.
g) Click Yes, insert.
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6. Create a variable: StringList

• Tipo: Elenco
• Subtype: String
• Name: StringList

7. To retrieve the list of child nodes from a node path, use the JSON > Get node list action.
a) From the Actions pane, double-click or drag the JSON > Get node list action.
b) In the JSON node key or path field, enter feeds.
c) In the Session name field, enter Default.
d) In the Save the outcome to a variable field, select StringList.
e) To print all the child nodes under the feed 51 object, double-click or drag the Message box

action.
f) To open the list of your variables, in the Enter the message to display field, press F2, and then

select StringList[51].
g) Click Yes, insert.

8. To close a JSON session, use End session. In the Session name field, enter Default.
9. Click Save and then click Run.
10. Start a new JSON session.

a) From the Actions pane, double-click or drag the JSON > Start session action. In the Data
Source field, select Text and enter StringList[52].

b) From Json object session, select Local session and enter Default 1 as the session name.
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11. To retrieve the value from a specific node, use JSON > Get node value.
a) From the Actions pane, double-click or drag the JSON > Get node value action.
b) In the JSON node key or path field, enter description.
c) In the Session name field, enter Default 1.
d) In the Save the outcome to a variable field, select SampleString.
e) To print the value of the description node, double-click or drag the Message box action.
f) To open the list of your variables, in the Enter the message to display field, press F2, and then

select SampleString.
g) Click Yes, insert.

12. To close the JSON session, use End session. In the Session name field, enter Default 1.
13. Click Save and the click Run.

You can further perform operations to extract the required information from the JSON feed and use
the extracted values in your bot. To extract the name value from feed 50 through 60, perform the
following steps.

14. Create a variable: ListItem

• Tipo: String
• Name: ListItem

15. To process each item in the list, use the Loop action.
a) Fai doppio clic o trascina l'action Loop.
b) Select the For each item in the list iterator.
c) In the List field, select StringList.
d) Choose the Range option and for the following fields, enter the values provided:

• From Index: 50
• To index: 60

e) In the Assign the current value to variable field, select ListItem.
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16. Start a new JSON session.
a) From the Actions pane, double-click or drag the JSON > Start session action.
b) In the Data Source field, select Text and enter ListItem.
c) To create a JSON session, from Json object session, select Local session and enter Default

 2 as the session name.

17. To retrieve the value from a specific node, use the JSON > Get node value action .
a) From the Actions pane, double-click or drag the JSON > Get node value action.
b) In the JSON node key or path field, enter name.
c) In the Session name field, enter Default 2.
d) In the Save the outcome to a variable field, select SampleString.
e) To print the value of the name node, double-click or drag the Message box action.
f) To open the list of your variables, in the Enter the message to display field, press F2 , and

then select SampleString.
g) Click Yes, insert.

18. Click Save and then click Run.
The name values retrieved from the feeds 50 through 60 are as follows:

Feeds (object) Nome

50 Ashish

51 Sophia

52 Ritu

53 Shivam

54 Navya

55 Faiz

56 Martin

57 Shweta

58 Jagjit

59 Mark

60 Sophia

Example of using a file variable
This bot building example uses a file variable containing employee addresses, and the bot extracts and
prints the required information into a message box.
Depending on the operation you want to perform, you can retrieve variable values from CSV or text files to
build automations. In this example you:
• Create a bot to read the data from the CSV file (addresses.csv)
• Retrieve the address of an employee
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Before you build the bot, you can create the following data sets on your desktop:

Roy Doe 120 Jefferson St. Riverside IT_PROG

Shaun McGinnis 220 Hobo Av. Rocky Point FI_ACCOUNT

John Mark 124 Jefferson St. Riverside SA_HEAD

Sophie Tyler 7300 Terrace "At
the Plaza" Rd.

Wells IT_PROG

Stephen Mathew 22 Theressia St. Troy IT_PROG

Anne Ross 9th St. Lexington IT_PROG

1. Create a bot.
a) Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei bots disponibili.
b) Fai clic su Crea nuovo > bot.
c) Enter a name for the bot: Employee Data.
d) Fai clic su Crea e Modifica.

2. Create a user defined variable: $varFile$.
3. Use Open action from CSV/TXT package and specify the file variable as: $varFile$.
4. Use the Read action to retrieve values from a CSV file (addresses.csv) and insert them into a

Table variable (TableFromCSV) to perform operations with the data values.
5. Use Message Box to print the value of the $TableFromCSV[3][2]$.
6. Click Save and Run

The bot displays the address: 7300 Terrace "At the Plaza" Rd.

Creare variabili di tipo Dizionario
Utilizzare Automation 360 per creare variabili di tipo dizionario utilizzando diversi sottotipi di dizionario e
parametri di tipo valore chiave.
• Assicurati di avere accesso a Control Room.
• È necessario disporre delle credenziali con autorizzazioni AAE_Basic.
• La postazione di lavoro è un dispositivo registrato in Control Room.

1. Accedi a Control Room.
2. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
3. Click the Create a bot icon.
4. Nel campo Nome, immetti DictionaryMapping, quindi fai clic su Crea e modifica.
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5. Crea quattro nuove variabili personalizzate:
a) Create a new Dictionary1 variable of Type > Dictionary and Subtype > String, and then click

Apply.
b) Create a new Dictionary2 variable of Type > Dictionary and Subtype > String, select Use as

output, click Add (+) sign, and enter Key and Value as strings, and then click Apply.
c) Create a new Dictionary3 variable of Type > Dictionary and Subtype > Number, click Add

sign, and enter Key as a string and Value as a number, and then click Apply.
d) Create a new Dictionary4 variable of Type > Dictionary and Subtype > Any, click Add sign,

and enter Type > String > Key > Name > Value as a number Type > Datetime > Key >
Date, enter Value for Datetime location, enter Type > Boolean > Key > Result > Value >
True, and then click Apply.

6. Nel riquadro Azioni, trova la Finestra di messaggio. In Inserisci il messaggio da mostrare,
immetti F2, quindi seleziona la variabile Dictionary1 > Chiave Dizionario > Nome.

7. Salva il bot ed esegui il TaskBot DictionaryMapping.

Concetti correlati
How to examples alla pagina 2375
This section contains code examples and explanations about how to code some basic bot capabilities.

Automation Anywhere Robotic Interface (AARI)
Automation Anywhere Robotic Interface or AARI provides a simple, front-end interface for users to execute
and interact with bots and applications.
Use AARI from within applications such as Salesforce and within browsers and desktops for end-to-end
process automation across the enterprise by connecting bots in the front and back offices.

Perché usare AARI

AARI aiuta a raggiungere i seguenti obiettivi:
• Semplificare le attività quotidiane, come il reporting e il monitoraggio delle richieste urgenti.
• Collaborare facilmente con applicazioni e bots del tuo team, migliorando così il tempo medio di gestione

e il tasso di risoluzione, il che aiuta a migliorare la soddisfazione del cliente.
• Accelerare anche le richieste più complesse automatizzando le escalation e le approvazioni.
• Accelerare il ritorno sull'investimento grazie al minimo investimento in infrastrutture, formazione e costi

di set-up per la tua azienda.

Cosa si può fare con AARI

AARI permette la comunicazione in tempo reale tra utenti e bots. Utilizzando AARI per automatizzare
le attività ripetitive e che richiedono tempo, è possibile migliorare l'esperienza del cliente, aumentare la
produttività dei dipendenti e ridurre i costi operativi dell'organizzazione.
L'immagine seguente illustra come AARI migliora l'automazione.
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Accessing AARI

AARI provides various interfaces that you can use to connect to business workflows at multiple
touchpoints. Access AARI in the following ways:
• Web browser

Access AARI through a URL to manage front and back office functions, gathering input and approval
from a single interface.

• Desktop
Retrieve and update data with custom forms. Users can view and interact with all data from a single
screen instead of switching between multiple systems.

• Applicazioni
Execute bots from common enterprise applications such as Salesforce and Google Workspace through
Automation Anywhere pre-built integrations.
• RPA Bots for Salesforce
• RPA Bots for Google Workspace

The following image illustrates the difference in the process flow between AARI on the web and AARI
desktop:
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Concetti correlati
Utilizzo di AARI sull'interfaccia Web alla pagina 2109
L'interfaccia Web Automation Anywhere Robotic Interface (AARI) è un portale intuitivo e uno spazio di
lavoro dedicato che consente agli utenti AARI di creare richieste ed eseguire attività e ai gestori di AARI di
creare ruoli e distribuzioni dei team.
Using AARI on desktop alla pagina 2179
Use Automation Anywhere Robotic Interface (AARI) through your desktop to manage routine tasks such as
validating data, retrieving approvals, and managing escalations through bots.

Utilizzo di AARI sull'interfaccia Web
L'interfaccia Web Automation Anywhere Robotic Interface (AARI) è un portale intuitivo e uno spazio di
lavoro dedicato che consente agli utenti AARI di creare richieste ed eseguire attività e ai gestori di AARI di
creare ruoli e distribuzioni dei team.
AARI su interfaccia Web offre un'esperienza coinvolgente con bots assistiti e non assistiti. Offre un punto
unico da cui visualizzare e organizzare documenti e attività, eseguire azioni e consegnare il lavoro ai bots.
Inoltre, fornisce un approccio centrato sul processo per ottenere l'automazione.

Capabilities

AARI su interfaccia Web aiuta l'utente nei seguenti modi:
• Avviando l'automazione da un catalogo di processi facile da usare.
• Automatizzando l'esecuzione dei flussi di lavoro di lunga durata tra più utenti e bots.
• Gestendo le eccezioni bot.
• Formando gli utenti e riducendo gli errori grazie all'automazione guidata.
• Multitasking con persone e bots.
• Monitorando e controllando l'automazione assistita.

AARI sul Web aiuta più utenti a collaborare con i bots senza interruzioni e senza accedere ai dati personali
identificabili (PII) e a sistemi riservati.
L'immagine seguente illustra la capacità di automazione del front-office:
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Componenti

AARI su interfaccia Web include i seguenti componenti:

Bots I bots automatizzano attività specifiche, ripetitive e
basate su regole.

Modulo Il modulo permette alle persone di invocare e
interagire con i bots attraverso l'interfaccia Web
personalizzabile.

Processo Il processo collega insieme i bots e i moduli. Il
processo contiene la logica per l'attivazione dei bots
e i moduli per il coordinamento del flusso di dati tra
di essi.

Richiesta La richiesta è un'istanza di un processo. Se il
processo definisce un modello del modo in cui i bots
e i moduli interagiscono, la richiesta è un'istanza
specifica di quel modello.

Attività Le attività sono i passaggi che devono essere
eseguiti all'interno di un processo. I processi
possono avere due tipi di attività:
• Attività umana: Attività che viene eseguita da

una persona; un'attività umana è un modulo.
• Attività Bot: Attività che viene eseguita da un

bot.

Osserva la seguente immagine per comprendere meglio la relazione tra questi componenti.
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Architettura

Le seguenti immagini illustrano l'architettura di AARI sull'interfaccia Web:
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Impostazioni

Il seguente flusso di lavoro illustra come utilizzare AARI sull'interfaccia Web per automatizzare e gestire le
attività:
1. Configura e imposta i ruoli

2. Configura i processi
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3. Distribuisci processi

Nota:  Per visualizzare le attività dell'interfaccia Web di AARI in un formato visivo interattivo, consulta Get
started with AARI.

AARI web interface users
Various users are involved in AARI on the web interface and each user contributes in different ways to help
automate the business requirements.
AARI users are broadly categorized into two types, users who can access the Control Room and users who
have access only to the web interface. Each user's role and responsibilities vary depending on the stage of
the workflow.

Users and their roles

The following table illustrates the relationship between users, roles, and the permissions they have while
using AARI on the web interface.

Utente Ruolo Autorizzazioni

Control Room administrator AAE_Admin Create users with AARI license
and assign roles.

Bot Creator AAE_Basic • Create a process.
• Check in a process.
• Check out a process.
• Run a private process.
• Delete a process.
• Import a process.
• Export a process.

AARI admin AAE_Robotic Interface
Admin

• Configure scheduler user
and allocate Control
Room resources (device
pool and unattended Bot
Runners) to a process in the
configuration setup stage.

• Perform the following
global team and process
management tasks in the
process deployment stage:
• Create, view, and modify

all teams.
• Assign teams to

processes.
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Utente Ruolo Autorizzazioni

Gestore AARI Gestore AAE_Robotic
Interface

• Create and view teams.

Nota:  Requires the AARI
license.

• Add members to or remove
members from the teams.

• Assign owners to the teams.
• Function as default admin

for the teams they create.
• Request AARI admin

to assign their team to
processes.

Utente AARI Utente AAE_Robotic
Interface

• Create and access requests.
• Submit and access tasks.

Team roles and permissions

The following table lists the users, and their roles and permissions in an AARI team.

Nota:  These roles require the AARI license.

Team role Control Room role Team type Autorizzazioni

Shared • Crea
• Visualizza tutto
• Elimina tutti
• Assegna tutto
• Modifica il team

Admin Gestore
AAE_Robotic
Interface

Private • Crea
• Visualizza tutto
• Elimina tutti
• Assegna tutto
• Modifica il team

Owner Utente AAE_Robotic
Interface

Shared • Crea
• Visualizza tutto
• Elimina tutti
• Assegna tutto
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Team role Control Room role Team type Autorizzazioni

Private • Crea
• Visualizza tutto
• Elimina tutti
• Assegna tutto

Shared • Crea
• Visualizza tutto
• Elimina
• Assegna tutto

Member Utente AAE_Robotic
Interface

Private • Crea
• Visualizza
• Elimina
• Assegnazione

automatica

Nota:  Il ruolo Gestore AAE_Robotic Interface attribuisce automaticamente al gestore AARI il ruolo di
amministratore del team.

Esempio

Consider two teams, Finance and HR, and their team roles as listed in the following table:

Finance (private) HR (shared)

Utente Ruolo Utente Ruolo

User A Proprietario User X Membro

User B Membro User Y Membro

User C Membro User Z Proprietario

For any process, keep in mind the following:
• User A can view and delete all the requests created inside the team Finance.
• Users B and C can view and delete only their requests inside the team Finance.
• Users X, Y, and Z can view all the requests but can delete only their request inside the team HR.
• User Z can view and delete all the requests created inside the team HR.

Configure roles for AARI on the web
Configure users and assign them the AARI license and relevant roles and permissions to start using the
web interface.
As AARI is already installed in the Control Room, you do not need to install it separately in the web
interface.
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The primary users involved in the configuration stage are as follows:
• Control Room administrator: The Control Room administrator creates users and assigns AARI roles

(AARI admin, manager, and user) with the AARI licenses.
Creazione di utenti per Automation Anywhere Robotic Interface alla pagina 2116
.

• AARI admin: The AARI admin creates the scheduler user and allocates Control Room resources required
to run a process.
Configure scheduler user for AARI on the web alla pagina 2118
.

Workflow map: Click the following schematic image to view the AARI workflow in an interactive visual

format:
1. Get started with AARI

Concetti correlati
AARI web interface users alla pagina 2113
Various users are involved in AARI on the web interface and each user contributes in different ways to help
automate the business requirements.

Creazione di utenti per Automation Anywhere Robotic Interface
Create the Automation Anywhere Robotic Interface (AARI) admin, manager, and users to use the AARI
functionality for business processes. The Control Room admin creates users and assigns the required
system roles.
Ensure that you have purchased the AARI user license for your business users.

Nota:  These roles are only applicable for the web interface.

1. Dal computer locale, accedi alla Control Room come amministratore .
2. Vai ad Amministrazione > Utenti.
3. Fai clic su Crea utente.

L'icona viene visualizzata nella parte superiore destra della tabella Utenti.
Viene visualizzata la pagina Crea utente.

4. Nella sezione Dettagli generali, inserisci i seguenti dettagli dell'utente:

Abilita utente Seleziona la casella di controllo in modo che
l'utente possa accedere immediatamente.
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Nome utente Inserisci un nome utente univoco.
Descrizione Facoltativo: Inserisci una descrizione per l'utente.
Nome Facoltativo: Immetti il nome dell'utente.
Cognome Facoltativo: Inserisci il cognome dell'utente.
Password Type and confirm a password for the user. Ensure

the password follows any necessary password
policy.

E-mail Inserisci e conferma l'indirizzo e-mail dell'utente.
Se il protocollo SMTP è abilitato, all'utente
viene inviata un'e-mail a questo indirizzo per
confermare l'account. Fai clic sull'URL nell'e-mail
per accedere alla Control Room e configurare
le credenziali. Tutte le notifiche importanti della
Control Room verranno inviate a questo indirizzo
e-mail.

5. Nella sezione Seleziona ruoli, seleziona uno dei seguenti ruoli dalla colonna Ruoli disponibili.
Ruolo Seleziona questo ruolo

Amministratore AAE_Robotic Interface Admin

Manager Gestore AAE_Robotic Interface

Utente Utente AAE_Robotic Interface

6. Click the right arrow to move the role to the Selected column.
7. In the Allocate a device license section, select the following:

Ruolo Azione

Amministratore Retain the default None.
The user with administrator role has access to
the Control Room and AARI on the web.

Manager Retain the default None.
You can optionally assign the AARI user license
to create a request, submit tasks, and create and
view teams.
The user with manager role has access to AARI
on the web.

Utente Assign the AARI user license. You can also
optionally assign the attended Bot Runner license
to run local bots or use the desktop interface.
The user has access to AARI on the web.

8. In the AARI licenses section, select the AARI user check box.
9. Fai clic su Crea utente.

Il nuovo utente viene visualizzato nella tabella Utente. Se il protocollo SMTP è abilitato, al nuovo
utente creato verrà inviata un'e-mail di invito a effettuare l'accesso.
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Configure scheduler user for AARI on the web
You can configure a scheduler user (global scheduler or per-process scheduler) to allocate the Control
Room resources (devices and unattended Bot Runners) to AARI on the web interface. This scheduler user
is a dedicated user who helps in process deployment.
The role assigned to the scheduler user cannot be a shared role with any other user such as Bot Runner or
an admin user. To perform this task, you will use both the Control Room and AARI web interface.
1. Create a scheduler user with a role in the Control Room.
2. Create device pools in the Control Room.

Nota:  The AARI administrator is the device pool owner, and you must select your custom role
(AARI-pool-scheduler) in Device Pool Consumers.

3. Assign a scheduler user to a process in the web interface.

Create user and assign role
Create a scheduler user and assign custom role to run the AARI process in the web interface.
You must be an AARI administrator to perform this task.
1. Accedi alla Control Room come amministratore.
2. Vai a Amministrazione > Ruoli.
3. Create a custom role.

For example, AARI-pool-scheduler.
Create a role alla pagina 2693.
a) Imposta le autorizzazioni per Visualizza i miei bot, Visualizzare pacchetti, Esegui i miei

bot e Pianificatore AARI.
b) In the Bots tab, select the folders that contain the bots to be run by the AARI scheduler user,

that you want to give access to with run and view permissions. Set the required bot permissions
for the role at the folder level.

c) Seleziona i tuoi utenti non assistiti nella sezione Esegui come.
d) Salva le modifiche.

4. Create a user.
For example, AARI-scheduler-user.

Nota:  This user does not require any license.

5. Assign the custom role you created to this user.
For example, AARI-pool-scheduler.

Assegnazione dell'utente del pianificatore al processo nell'interfaccia web
Puoi configurare un utente del pianificatore (pianificatore team, pianificatore per processo o pianificatore
globale) affinché assegni le risorse della Control Room (dispositivi ed Esecutori di bot non assistiti) ad
AARI sull'interfaccia web. Questo utente pianificatore è un utente dedicato che facilita la distribuzione dei
processi.
Assicurati di aver creato l'utente pianificatore e il pool di dispositivi.
1. Accedi all'interfaccia web come amministratore AARI.
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In alternativa, puoi accedere all'interfaccia web con il tasto Control Room facendo clic sul collegamento
per la pagina delle impostazioni nella schermata Gestisci > Pool di dispositivi. Questo ti porterà
automaticamente alla schermata dell'interfaccia web di AARI, con l'accesso come amministratore
AARI.

2. Seleziona un utente pianificatore scegliendo una delle seguenti opzioni:
Il processo AARI utilizza il pool di dispositivi e Bot Runners non assistiti configurati con questo utente
per ogni distribuzione di bot.
Per impostazione predefinita è selezionato Pianificatore globale se non è stato impostato un
Pianificatore per i processi.
Per impostazione predefinita:
a. È selezionato l'utente pianificatore Team.
b. È selezionato l'utente pianificatore Processo se l'utente pianificatore Team non è definito.
c. È selezionato l'utente Pianificatore globale se gli utenti pianificatori Team o Processo non

sono selezionati

Tipo di pianificatore Fasi

Team a. Accedi a Gestisci > Processo.
b. Seleziona il processo per configurare l'utente

pianificatore.
Si aprirà la pagina Modifica processo.

c. Accedi alla scheda Team.
d. Seleziona un utente pianificatore dal menu a

discesa nel campo Pianificatore.
Il Pianificatore processo è selezionato per
impostazione predefinita.

e. Fai clic su Salva.

Pianificatore (pianificatore per processo) a. Accedi a Gestisci > Processo.
b. Seleziona il processo per configurare l'utente

pianificatore.
Si aprirà la pagina Modifica processo.

c. Accedi alla scheda Distribuzione.
d. Seleziona un utente pianificatore dal menu a

discesa nel campo Pianificatore processo.
Il Pianificatore globale è selezionato per
impostazione predefinita.

e. Seleziona il tipo di Distribuzione.
f. Fai clic su Chiudi.

L'impostazione viene salvata
automaticamente.
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Tipo di pianificatore Fasi

Pianificatore globale a. Accedi a Gestisci > Processo.
b. Seleziona il processo per configurare l'utente

pianificatore.
Si aprirà la pagina Modifica processo.

c. Accedi alla scheda Distribuzione.
d. Seleziona l'utente Pianificatore globale

dal menu a discesa nel campo Pianificatore
processo.
Il Pianificatore globale è selezionato per
impostazione predefinita.

e. Seleziona il tipo di Distribuzione.
f. Fai clic su Chiudi.

L'impostazione viene salvata
automaticamente.

Importante:  Se agli utenti del pianificatore è stato rimosso il ruolo o non dispongono di
autorizzazioni sufficienti per accedere a un file:
a. L'amministratore Control Room visualizzerà un log di audit della modifica.
b. L'amministratore AARI visualizzerà un messaggio di errore per un pianificatore non valido e dovrà

riassegnare un nuovo utente pianificatore.
c. L'utente AARI visualizzerà un messaggio di errore per il processo.

Configurazione del tipo di distribuzione per i bots
Puoi configurare il tipo di distribuzione per le attività dei tuoi bot. Questo determina il modo in cui i bot nel
processo saranno distribuiti. Puoi anche definire la mappatura tra Esegui come utente e il dispositivo.

Questa mappatura aiuterà a tenere conto di eventuali vincoli nella tua organizzazione, come quelli delle
credenziali che richiedono una mappatura uno a uno tra i dispositivi ed Esegui come utente.
1. Accedi a Gestisci > Processo.
2. Seleziona il processo.
3. Seleziona la scheda Distribuzione.
4. Nel campo Tipo di distribuzione, seleziona una delle seguenti opzioni:

• Preferisci il dispositivo predefinito - Il bot viene distribuito sul dispositivo predefinito
dell'utente Bot Runner non assistito. Se il dispositivo predefinito non è disponibile, il bot viene
distribuito sul dispositivo disponibile nel pool di dispositivi. Tutti gli utenti Bot Runner non assistiti
nell'utente pianificatore devono avere le stesse credenziali del dispositivo (nome utente e
password) o le diverse credenziali di nome utente e password impostate in tutti i dispositivi. Se la
password è diversa per ogni credenziale di dispositivo, anche il nome utente è diverso.

• Esegui su pool di dispositivi - Il bot viene distribuito sul dispositivo disponibile nel pool di
dispositivi. Ignora il dispositivo predefinito dell'utente.

• Esegui solo sul dispositivo predefinito - Il bot viene distribuito solo sul dispositivo predefinito
dell'utente. In questa opzione, l'utente Bot Runner non assistito deve possedere il dispositivo
predefinito. Se il dispositivo è di proprietà congiunta dell'utente Bot Runner non assistito e di
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un altro utente con licenza, il dispositivo non viene utilizzato in quanto si considera che l'utente
Bot Runner non assistito non disponga di un dispositivo predefinito. Se l'utente pianificatore ha
più utenti Bot Runner non assistiti e uno di questi utenti non ha un dispositivo predefinito, la
distribuzione del bot fallisce.

5. Fai clic su Chiudi.

Configura i processi
AARI fornisce automazioni di front-office e back-office, in cui l'utente Bot Creator crea un flusso di lavoro di
processo con attività umane e bot secondo le esigenze aziendali.
A Bot Creator user can configure a process in the Process Composer in the Control Room. The Process
Composer provides a drag-and-drop interface to help create process flows. Permette all'utente di
configurare il momento in cui un bot dovrebbe essere eseguito. Mostra anche i dati corretti agli utenti e
scambia i dati tra più team.

Progettazione dei processi

Un processo è costituito da attività umane e bot. Un processo è costituito dai seguenti componenti:
• Un modulo di iscrizione, che è il primo passaggio di un processo.
• Una sequenza di elementi di processo come segue:

• Moduli o TaskBots
• Input, output e metavariabili per la condivisione dei dati

• Condizioni logiche come If, Else per la ramificazione interna e condizionale del processo.
• Stati finali per chiudere ogni richiesta, ad esempio come completata, non riuscita o annullata.

Progettazione di moduli

Un utente Bot Creator può creare un modulo e inserire i dati richiesti utilizzando elementi del modulo che
possono essere rappresentati nell'interfaccia web. Può aggiungere o rimuovere azioni sul modulo durante
la creazione di processi.
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In qualità di utente, puoi interagire con il modulo solo quando ti è stato assegnato. Se il modulo non è
assegnato, non è abilitato ed è di sola lettura. Per modificare il modulo, puoi assegnarlo a se stessi o a
qualsiasi membro del team che abbia accesso al processo. Dopo aver modificato il modulo, l'assegnatario
può inviare il modulo o utilizzare qualsiasi altra opzione di azione. Dopo che il modulo è stato inviato o
è stata utilizzata un'opzione di azione, la visualizzazione della richiesta mostra il passaggio o l'attività
successivi.
Nell'interfaccia web, sono supportati in un modulo i seguenti elementi:
• Casella di controllo
• Data
• Documento
• Elenco a discesa
• Collegamento ipertestuale
• Immagine
• Etichetta
• Numero
• Password
• Pulsante di opzione
• Rich Text Editor
• Seleziona un file
• Tabella
• Area testo
• Casella di testo
• Ora

Progettazione di TaskBots

Un utente Bot Creator può creare un TaskBot che verrà eseguito all'interno del processo utilizzando le
variabili di input e output. Quando la casella di controllo Usa come input è selezionata, il processo passa
i dati nelle variabili di input, mentre quando la casella di controllo Usa come output è selezionata, il
processo ottiene i dati dalle variabili di output dopo l'esecuzione di bot.

Flusso di lavoro del processo

Il seguente flusso di lavoro descrive i passaggi coinvolti nella costruzione di un processo AARI e nel
renderlo disponibile nell'interfaccia web:
1. Crea un processo AARI alla pagina 2133.

a. Crea un TaskBot.
b. Create an AARI form alla pagina 2123.

2. Check in an AARI process alla pagina 2149.
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Altre attività

A seconda dei requisiti, un utente Bot Creator può anche eseguire altri compiti dopo aver creato un
processo:
• Se c'è un cambiamento nel requisito, un utente Bot Creator può estrarre il processo nella sua area di

lavoro privata e modificare il processo secondo il requisito.
Check out an AARI process alla pagina 2149.

• Il Bot Creator può testare il processo prima di archiviarlo eseguendolo nell'area di lavoro privata.
You can run the process either in the public or the private workspace using the Run option in the
Process Composer. Il bots nel processo privato viene eseguito sul dispositivo predefinito del Bot
Creator.
Quando il processo privato viene eseguito, il Bot Creator può creare una richiesta, immettere dati nel
modulo iniziale ed eseguire la richiesta dall'area di lavoro privata. Le richieste create dall'esecuzione
del processo privato possono essere visualizzate solo dall'utente che crea la richiesta. Le richieste
create dall'esecuzione del processo pubblico possono essere visualizzate dall'amministratore di AARI. I
manager e gli utenti possono visualizzare le richieste solo se hanno accesso al processo.
Eseguire un processo AARI alla pagina 2148.

• Accedi a un processo da una Control Room all'altra importando o esportando il processo. Per esempio,
se un processo è sviluppato e testato nel pod di staging ed è ora pronto per la produzione, può essere
esportato dal pod di staging. Allo stesso modo, questo processo esportato può essere importato nel pod
di produzione.
• Importazione di un processo AARI alla pagina 2150.
• Export an AARI process alla pagina 2152.

• Se un requisito diventa ridondante, il processo creato può essere eliminato.
Eliminare un processo AARI alla pagina 2148.

Concetti correlati
AARI web interface users alla pagina 2113
Various users are involved in AARI on the web interface and each user contributes in different ways to help
automate the business requirements.

Create an AARI form
Create an Automation Anywhere Robotic Interface (AARI) form to provide interaction between humans and
bots. You can enter the required data using form elements that can be rendered in the web interface. You
can add or remove form actions when creating the process.
• È necessario disporre di una licenza Bot Creator.
• Deve esserti assegnato un ruolo personalizzato con le seguenti autorizzazioni per la cartella di

creazione.

Forms in AARI can be displayed in two scenarios:
• Case creation: This is the initial form that is displayed when you want to create a new case and enter

the required business data.
• Form step: This form is displayed to show information and prompt for additional inputs.

1. Nel pannello di sinistra, fai clic su Automazione.
Viene visualizzato un elenco dei moduli e dei  disponibili.

2. Click Create new > Form.
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3. Nella pagina Crea modulo, immetti un nome per il nuovo modulo.
I processi vengono salvati nella cartella \Bots\ per impostazione predefinita. Fai clic su Sfoglia per
modificare la cartella predefinita.

4. Fai clic su Crea e modifica.
The form builder page appears with a single row Column layout.

5. If you want to delete a row, click the vertical ellipsis in the form layout and click Delete row.
6. Confirm the delete action in the confirmation message.
7. Drag the required element into the form from the Elements panel on the left.
8. Use the Properties panel on the right to update or change the form properties.
9. Fai clic su Salva.
10. Fai clic su Chiudi.

Crea un processo AARI alla pagina 2133
Attività correlate
Example of uploading and downloading file for web alla pagina 2127
This task is a use case of how to use the Select File element to upload or download files that are passed
in the initial forms in the web interface.

Example of using the Checkbox element dynamically
The Checkbox element in the AARI form enables you to select multiple options in a form during bot
runtime. In this example, use the Checkbox element to generate dynamic options.
You must have a Bot Creator license and be assigned a custom role with create folder permission.
In this example, we will create a process to register new employee details in the company database. The
initial form contains basic information such as Name, ID, Date of Birth, Gender, and Location. The initial
form has only two options (San Jose and Tokyo) for the Location field. We will make this field dynamic
where during requestion creation, a new location (India) is added for those employees whose ID is in the
100 to 200 range.
1. Log in to the Control Room as a Bot Creator user.
2. Create the initial form.

Create an AARI form alla pagina 2123.
a) On the left plane, click Automation.
b) Click Create new > Form.
c) Enter the form name employee_register_initial_form.
d) Enter the folder location Bots\Employee Registration.

To change where your form is stored, click Choose and follow the prompts.
e) Fai clic su Crea e modifica.
f) Use the following Elements and Element label in the form.

Elementi Etichetta elemento

TextBox Full Name

Numero ID

Data Date of Joining
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Elementi Etichetta elemento

Elenco a discesa Gender

For the Dropdown element, enter Male, Female in the Enter list items separated by
commas field.

g) Fai clic su Salva.
h) Fai clic su Chiudi.

3. Create another form.
a) In the same folder location, click Create new > Form.
b) Enter the form name employee_location.
c) Fai clic su Crea e modifica.
d) Drag the Checkbox element into the form.
e) Enter the name in the Element label field Employee location.
f) Click the plus icon in the Checkbox content field and add the locations San Jose and Tokyo.
g) Fai clic su Salva.
h) Fai clic su Chiudi.

4. Create a new bot.
a) In the same folder location, click Create new > Bot.
b) Enter the bot name dynamic_checkbox.
c) Fai clic su Crea e modifica.

5. Create the following variables:
• emp_id: Number type; use as input
• emp_location: List type, String subtype; use as output; click the plus and add two values San

 Jose and Tokyo
• emp_dyn_location: String type, add the default value India

The default values are San Jose and Tokyo but if the employee ID falls between 100 and 200, the
location India is selected.
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6. Use the If action to configure the conditional statement.
a) Double-click or drag the If action.
b) Select Number from the Condition drop-down list.
c) In the Source value field, insert the variable $emp_id$.
d) Select Greater Than (>) as the Operator.
e) Enter 100 in the Target value field.
f) Click Add condition and select And.
g) Select Number from the Condition drop-down list.
h) In the Source value field, insert the variable $emp_id$.
i) Select Less Than (<) as the Operator.
j) Enter 200 in the Target value field.
k) Fai clic su Salva.

7. Use the List package into the If container to insert the new location as per the defined condition.
a) Drag the List > Add item action.
b) In the List variable field, select the variable in which to add the list item emp_location.
c) In the Item to be added field, select the variable that contains the value to add

emp_dyn_location.
d) Fai clic su Salva.
e) Fai clic su Chiudi.
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8. Create a new process.
a) In the same folder location, click Create new > Process.

Crea un processo AARI alla pagina 2133.
b) Enter the process name employee_register.
c) Fai clic su Crea e modifica.
d) Click Start to add an initial form to the process.
e) In the Select initial data form field, browse and select the initial form, that is

employee_register_initial_form.
f) Provide Request title as Employee Registration.
g) Drag the Bot Task into the Process Composer from the Task field.
h) In the Bot Task panel, Element name field, enter a name Location.
i) Enter the Task name Generate location.
j) In the Select Task Bot field, browse and select the bot you created dynamic_checkbox.
k) In the Input values field, select the input variable emp_id.
l) Drag the Human Task into the Process Composer from the Task field.
m) In the Human Task panel, Element name field, enter a name location_form.
n) Enter the Task name Employee location form.
o) In the Select form field, browse and select the form you created employee_location.
p) Click Add button.
q) Specify OK for Button label and Primary for Button style.
r) Select the Feed data into form check box, Employee Location[CheckBoxGroup0].

Set the two variables from the bot as output variables.
s) In the List of options field, select the output variable $Location.output[emp_location]$.
t) In the Default value field, select the output variable $Location.output[emp_dyn_location]$.
u) Fai clic su Salva.
v) Fai clic su Chiudi.

9. Deploy the process.
a) Fai clic su Esegui.

A request is created for the process.
b) Enter the values for the initial form.
c) Fai clic su Invia.

The process deploys and if the employee ID falls between the values 100 to 200, the Employee
location field will have a new option of India making this option dynamic. If the employee ID is not
between the values 100 to 200, the Employee location field will have only two options, San Jose and
Tokyo.

Example of uploading and downloading file for web
This task is a use case of how to use the Select File element to upload or download files that are passed
in the initial forms in the web interface.
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• You must have a Bot Creator license and be assigned a custom role with the create folder permission.
• Assicurati di avere accesso a RPA Workspace.
• You must be provided a system-created AAE_Robotic_Interface User role with the AARI user

license, for the AARI user.
• Ensure you have access to the web interface.

1. Log in to the RPA Workspace as a Bot Creator
2. Create a form where the file can be accessed. Create a form to view documents alla pagina 2128.
3. Create a bot that can call and store the input file. Create a bot with Get Storage file acton alla pagina

2128.
4. Create a process that allows users to run the bot and access the file. Create a process to select a file

input alla pagina 2129.
5. Run the process and access the file. View uploaded file alla pagina 2130.

Create a form to view documents
Create a form to upload files and view documents.
1. Create a new form.

Let's name this form as File Form.
The new form window appears for you to design your form.

2. Drag and drop the Select File element into your form designer from the Elements column.
The Properties - Select File window now appears with relevant fields.

3. Specify a label in the Element label field.
For example: the element label is Select a file (PDF).

4. Specify the supported file format in the Enter supported file formats separated by commas
field.
In this case we would specify PDF.

5. Click Save and close the current window.
6. Create another form.

Let's name this form as View Document Form.
7. Drag and drop the Document element into your form designer from the Elements column.

Use the Image element, instead of the Document element, to add an image to your form.

Nota:  This works the same way as the Document element. File size should not exceed 150kb (like a
logo image) and supported file types are PNG, JPG, JPEG and GIF.

8. Optional: you can specify the window formatting and dimensions in the Properties - Document
window that appears.

9. Click Save and close the current window.
You have now successfully created a form with the Select File and Document element.
For your next steps on creating a bot, see Create a bot with Get Storage file acton alla pagina 2128.

Create a bot with Get Storage file acton

1. Create a new bot.
Let's name this bot as Bot File.
The new bot window appears for you to create a bot.

2. Select the plus (+) icon in the Variables field.
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The Create variable window appears.
3. Select File in the drop-down menu in the Type field.
4. Specify the variable name in the Name field.

Let's name this variable as FileVar.
5. Select only the Use as input.
6. Fai clic su Crea.
7. Drag the Get Storage file action from the AARI Web command.

The AARI Web Get Storage file window appears.
8. Select Variable.
9. Select the FileVar that you had created.
10. Specify the path in the Full path of file in local device to be saved to field.

Importante:  The full path of the file includes the name of the file (ex: C:\aari\output
\filename.pdf).

11. Fai clic su Salva.
You have successfully created a bot with the Get Storage file action.
For your next steps on creating a process, see Create a process to select a file input alla pagina 2129.

Create a process to select a file input
Create a process to select a file input.
1. Create a new process.

Let's name this process Process To Download File.
The Process Composer appears for you to create a process.

2. Click on Process entry.
The Start window appears.

3. Click Browse in the Select inital data form field
4. Set the initial form as File Form that you had created.
5. Specify the request title and task name.
6. Click Save and close the current window.
7. Drag and drop the Bot Task into your Process Composer from the Task field.

The Task: Bot Task window appears.
8. Specify your element and task name in the Element name and Task name fields.
9. Select your input value as the FileVar that you had created.
10. Click Save and close the current window.
11. Drag and drop the Human Task into your Process Composer from the Task field.

The Task: Human Task window appears.
12. Specify your element and task name in the Element name and Task name fields.
13. Select the Auto-assign this task to option.
14. Select the View Document Form in the Select Form field that you had created.
15. Click Add button option.
16. Specify your button labels and style Button label and Button style fields.
17. Select Document in the Feed data into form field.

Alternatively, select Image, if you had used the Image element instead.
18. Click Save and close the current window.
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You have successfully created a process to view files.
For your next steps to upload a file, see View uploaded file alla pagina 2130.

View uploaded file
Run your process and upload a file to view.
1. Click Run to run your process from the Process Composer.

The initial form window for the Process To Download File process appears with the Select a file
(PDF) option for you to upload a file.

2. Click browse to select a PDF file in the initial form.
You have uploaded your file to the initial form.

Importante:  File size is limited to 50MB.

3. Fai clic su Invia.
The request view page appears and the tasks are running.
One of the process steps will show you a preview of the file that was uploaded.

4. Click Done to confirm.
The PDF file is downloaded to the local machine at the file path you set.

5. Navigate to folder on your local machine (e.g. C:\aari\output) where you had specified the file
path.
The downloaded file should now appear in the folder location.

6. Click the PDF file to view your file.
You have succesfully uploaded a file and viewed that file.

Cloud storage usage
This topic describes the cloud storage based on the file size that is uploaded by the user.

Panoramica

Users who use the Select File element are able to upload files, these files are stored on the cloud and
have specific requirements.
Cloud Storage quota
The files that are uploaded by users are based on the maximum file and storage sizes.
The quota for cloud storage are as follows:
• The file size for when the user uploads a file using the Select File element cannot exceed 50 MB.

Importante:  The file limit is only attached to a Select File element and not a request. In addition,
you can only upload one file for each Select File element, however, there is no limit to the number of
Select File elements that can be added to a form.

• The cloud storage can store a maximum of 250 MB of data per tenant.

Nota:  This is set by default. The storage limit is per tenant and not per user.

• The storage for each tenant is extended to an additional 1 GB for every AARI user license that are
allocated in the tenant.
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Importante:  These storage restrictions is only applied to the process when used for AARI use cases.
However, there are no storage capacity restrictions for AARI Assistant storage and use cases.

Retention Policy
There is a retention policy for files that are uploaded to the cloud storage.
The retention policy are as follows:
File will be deleted 90 days after the time of the file upload.
When a request is deleted, the request and the associated file are permanently deleted and not just sent
to the recycle bin.

Nota:  This is supported only for requests with one associated file, not multiple files.

Example of uploading a file as a request input
This is an example of using forms to upload and view a PDF file.
1. You must have a Bot Creator license and be assigned a custom role with the create folder permission.
2. Assicurati di avere accesso a RPA Workspace.
3. You must be provided a system-created AAE_Robotic_Interface User role with the AARI user

license, for the AARI user.
4. Ensure you have access to the web interface.

1. Log in to the RPA Workspace as a Bot Creator
2. Create a form with the Select File element alla pagina 2132.

This is your first form.
3. Create a form with the Document element alla pagina 2132.

This is your second form.
4. Create a process to view files alla pagina 2132.

Now that you have created a process with data from two forms, you can now run your process.
5. Click Run in the Process Composer.

The initial form will now open in a separate tab for you to interact.
6. Click browse to select a file.

You need to navigate to the file path in your local machine.
7. Select a PDF file.

Importante:  File size is limited to 50MB.

8. Fai clic su Apri.
You should now be able to open that PDF file in your form.

9. Fai clic su Invia.
10. Click Done to confirm.

The PDF file is successfully uploaded.
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Create a form with the Select File element
You can create a form with the Select File element to select files.
1. Create a new form.

Let's name this form as Select File Form.
2. Drag and drop the Select File element into your form designer from the Elements column.

The Properties - Select File window now appears with relevant fields.
3. Specify a label in the Element label field.

This can be labeled as Upload a file.
4. Specify the supported file format in the Enter supported file formats separated by commas

field.
You can specify PDF.

5. Click Save to save your form session.
6. Click Close to close the current form window.

Create a form with the Document element
You can create a form with the Document element to select files.
1. Create a new form.

Let's name this form as Document Viewer Form.
2. Drag and drop the Document element into your form designer from the Elements column.

The Properties - Form window now appears with relevant fields.
3. Facoltativo: You can modify your document dimensions or keep the system default settings.
4. Click Save to save your form session.
5. Click Close to close the current form window.

Create a process to view files

1. Create a new process.
Let's name this process View a File Process.
The Process Composer appears for you to create a process.

2. Click the Start node (green icon).
This is the first node of your process entry.
The Start window now appears with relevant fields.

3. Click the Browse option in the Select initial data field to search for a form.
4. Click the Browse tab in the Find a form window.
5. Select the Select File Form that you had created.

This is your first form.
6. Click Choose to confirm.
7. Specify the title in Request title field.

You can name the title as Select File or similar.
Leave the rest of the entries as is.

8. Fai clic su Salva.
9. Drag and drop the Human Task from the Task column to your process work flow.

The Task: Human Task window appears.
10. Specify your element name in the Element name field.
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You can name the title as File or similar.
11. Click the Browse option in the Select form field to search for a form.
12. Click the Browse tab in the Find a form window.
13. Select the Document Viewer Form that you had created.

This is your second form.
14. Click Choose to confirm.
15. Specify your button details in the Add form button field.

You can specify Upload as the Button label and keep the Primary setting as the Button style.
16. Select the Document[Document0] option in the Feed data into form field.

This will show up as a check mark your selected option.
17. Click Insert a variable in the blank field.

a) Select Request as your variable source.
b) Select Input as your variable type.
c) Select Upload a file[File0]-File as your variable type.

This option should automatically be define for you to choose.
d) Click Add to add and confirm your variable.

18. Click Save to save your session.

Crea un processo AARI
Crea un flusso di lavoro di processo Automation Anywhere Robotic Interface (AARI) per soddisfare i
requisiti aziendali. You create the process in the Process Composer that incorporates human and bot tasks.
• È necessario disporre di una licenza Bot Creator.
• Deve esserti assegnato un ruolo personalizzato con le seguenti autorizzazioni per la cartella di

creazione.

Nota:  Each task, logic condition, and end point now supports the copy, paste, and cut elements from
the bot editor. Additionally, you can double-click to add and replace items on the canvas. Consulta
Behaviors supported in the Process Composer alla pagina 2144.

1. Crea un processo:
a) Dal computer locale, accedi a Control Room come Bot Creator.
b) Dal riquadro sinistro, fai clic su Automation, quindi su Crea nuovo > processo.
c) Nella pagina Crea processo, immetti un nome per il nuovo processo.

I processi vengono salvati nella cartella \Bots\. Fai clic su Sfoglia per modificare la cartella
predefinita.

d) Fai clic su Crea e modifica.
e) Facoltativo:Fai clic sul nome del processo per rinominarlo.

2. Aggiungi un modulo iniziale al processo facendo clic su Avvia.

© 2023 Automation Anywhere. All rights reserved.     2133



    Automation Anywhere - Crea

3. Dal pannello Avvia, esegui queste operazioni:
a) Sfoglia e Seleziona il modulo dati iniziale.
b) In the Request title field, enter any text or insert a variable.

Questa è la variabile di input. Per questa richiesta, viene creato un titolo dinamico che verrà
visualizzato nell'interfaccia Web e fungerà da riferimento.

Nota:  You can use a Reference ID such as ref ID = $RefId$. Reference ID is a Meta
variable type.

c) In the Task name field, enter the name of the task.
You can use a Reference ID such as task ref ID = $RefId$.

d) Facoltativo:In the Data privacy tag field (same as PII tag), enter a text or variable to generate
hidden custom output.

e) Fai clic su Applica.

4. Add Bot Task to AARI process alla pagina 2135.
The Bot Task runs a bot with inputs and outputs.

5. Add Human Task to AARI process alla pagina 2136.
The Human Task displays a form that requires interactions by a user.

6. Facoltativo:Add Filter Task to AARI process alla pagina 2139.
The Filter task allows you to filter a variable according to your specific criteria.

7. Facoltativo:Add Process Task to AARI process alla pagina 2139.
The Process Task enables for you to run a process.

8. Facoltativo:Add Document Validation to AARI process alla pagina 2140.
The Document Validation Task displays a validator for a document that requires validations.
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9. Aggiungi una condizione al processo trascinando la condizione dal pannello Elementi.
È possibile scegliere la coppia Se/Altrimenti o Altrimenti se.

10. Dal pannello Condizione, esegui queste operazioni:
a) Facoltativo:Aggiungi una descrizione nel campo Descrizione.
b) Facoltativo:Aggiungi un messaggio nel campo Visualizza messaggio.

Il messaggio visualizzato immesso viene mostrato nella pagina di visualizzazione della richiesta
nell'interfaccia Web.

c) Fai clic su Aggiungi condizione per aggiungere una condizione.
Puoi scegliere una condizione tra i quattro tipi disponibili: valore Booleano, Data/ora, Numero
o Stringa.

d) Fai clic su Applica.

11. Add an End Point to AARI process alla pagina 2141.
The End Process ends a process with a selected status while the Go to navigates to another tasks in a
process.
You have now configured your AARI process

12. Facoltativo:If you want to preview your bot or forms information in the Process Composer (Edit
process page) in both your public and private workspace, follow these steps.
a) Fai clic sui puntini di sospensione verticali accanto ad Attività Bot o adAttività umana.
b) Seleziona l'opzione Anteprima bot o Anteprima modulo.

Nell'area di lavoro pubblica, queste opzioni mostrano la pagina Anteprima nome bot o
Anteprima nome modulo. La pagina consente di visualizzare rapidamente un bot o un modulo.
Nello spazio di lavoro privato, queste opzioni mostrano la pagina Modifica Task Bot o Modifica
modulo in cui è possibile apportare modifiche al tuo TaskBot o al modulo.

Attività correlate
Creazione del primo bot alla pagina 1059
Attieniti alla seguente procedura per creare il primo bot che stampa il messaggio Go be great!, la
versione Automation Anywhere di Hello World!
Create an AARI form alla pagina 2123
Create an Automation Anywhere Robotic Interface (AARI) form to provide interaction between humans and
bots. You can enter the required data using form elements that can be rendered in the web interface. You
can add or remove form actions when creating the process.
Riferimenti correlati
About the AARI process in Document Automation alla pagina 2574
Document Automation uses Automation Anywhere Robotic Interface technology to manage the end-to-end
document extraction process. When you create a learning instance in Document Automation, the system
also creates an AARI process. Review the following guide to understand the logic.

Add Bot Task to AARI process
You can add a Bot Task to configure the settings.
1. Aggiungi una Attività bot al processo trascinando l'elemento dal pannello Elemento.
2. Dal pannello Attività bot, esegui queste operazioni:

a) Immetti un nome nel campo Nome elemento.
b) Inserisci il nome dell'attività nel campo Nome attività.

Il nome dell'attività viene visualizzato nell'interfaccia Web come riferimento. You can use a
Reference ID such as ref ID = $RefId$.
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c) Facoltativo:Seleziona la casella di controllo Nascondi questa attività dopo il
completamento.
Dopo il completamento dell'attività, l'Attività bot non viene visualizzata dall'utente nell'interfaccia
Web.
Per visualizzare l'attività nascosta, seleziona la casella di controllo Visualizza attività nascoste
nella pagina di visualizzazione delle attività dell'interfaccia Web.

d) Sfoglia e seleziona TaskBotnel campo Seleziona TaskBot.
e) Nella sezione Esegui bot e dipendenze usando, seleziona una versione dell'etichetta .

Puoi scegliere Versione più aggiornata (impostata per impostazione predefinita) o Etichetta
di produzione.
Il bot distribuisce la versione selezionata.

f) Nella sezione Priorità del bot fare riferimento al proprio bot livello di priorità.

Nota:  Il livello di priorità del bot è un'etichetta di sola lettura che indica Basso, Medio o Alto,
a seconda del livello di priorità impostato per bot. In precedenza, il livello di priorità era impostato
su Medio per tutti i bots, ma ora viene considerata la priorità bot.

Importante:  If the priority of a task bot was changed, you need to browse for the task bot
again in order to reflect the correct priority status for an existing AARI process.

g) Facoltativo:Nel campo Tag privacy dati, immetti un testo o una variabile per generare un
output personalizzato nascosto.
Seleziona la casella di controllo in Valori di input e specifica una variabile.
L'input della variabile previsto da bot viene mappato con la variabile che verrà popolata durante la
creazione della richiesta.
1. Seleziona un'attività nel campo Attività di processo.
2. Seleziona un tipo nel campo Tipo di variabile.

Puoi scegliere Input, Output oppure Meta.
Consulta AARI variable types alla pagina 2141.

3. Specifica la tua variabile nel campo Variabile.

Nota:  Reference ID is a Meta variable type.

4. Fai clic su Applica.

3. Fai clic su Salva.
You have now configured the Bot Task in your AARI process.

Add Human Task to AARI process
You can add a Human Task to configure the settings.
1. Aggiungi una Attività umana al processo trascinando l'elemento dal pannello Elemento.
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2. Dal pannello Attività umana, esegui le seguenti operazioni:
a) Immetti un nome nel campo Nome elemento.
b) Inserisci il nome dell'attività nel campo Nome attività.

Il nome dell'attività appare nell'interfaccia Web come riferimento. You can use a Reference ID
such as ref ID = $RefId$.

c) Seleziona la casella di controllo Nascondi questa attività dopo il completamento.
Dopo il completamento dell'attività, l'Attività umana non viene visualizzata dall'utente
nell'interfaccia Web.
Per visualizzare l'attività nascosta, seleziona la casella di controllo Visualizza attività nascoste
nella pagina di visualizzazione delle attività dell'interfaccia Web.

d) Seleziona la casella di controllo Rendi il modulo di sola lettura.
Attività umana non richiede alcun input ed esegue automaticamente l'attività successiva.

e) Seleziona la casella di controllo Assegna questa attività all'utente che ha creato questa
richiesta.
L'attività viene automaticamente assegnata all'utente che crea questa richiesta nell'interfaccia
Web.

f) Seleziona la checkbox Assegnazione automatica di questa attività a. Puoi selezionare le
seguenti opzioni dal menu a discesa:
• L'utente che ha creato la richiesta: L'attività viene automaticamente assegnata all'utente

che crea questa richiesta nell'interfaccia Web.
• L'utente che apre quest'attività: L'attività viene assegnata automaticamente all'utente che

apre l'attività nell'interfaccia Web.

g) In the Task expiration time field, select the time option.
You can choose from among the following options: No expiration (default), 1 hour, 1 day, 1
week, 2 week, 30 days, and Custom.

Nota:  If you choose the Custom option, you must specify the time by the number of days,
hours, and minutes. The maximum is 45 days, and the minimum is 1 minute. Days range from
0 to 45 days, and hours range from 0 to 23 hours. For minutes, if the hours and days are set to
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0, minute range is 1 to 59 minutes. However, if the hours and days are not set to 0, minute range
is 0 to 59 minutes.

h) Nel campo Seleziona modulo, sfoglia e seleziona il secondo modulo creato.
Su questo modulo viene visualizzato il risultato.

i) Nel campo Tag privacy dati, immetti un testo o una variabile per generare un output
personalizzato nascosto.

j) Specifica i dettagli del pulsante nel campo Aggiungi pulsante modulo.
• Specifica un nome nel campo Etichetta pulsante.
• Seleziona uno stile nel campo Stile pulsante.

È possibile scegliere tra Primario, Secondario o Annulla.
• Fai clic su Aggiungi pulsante per aggiungere altri pulsanti.

k) Seleziona la casella di controllo nel campo Inserisci dati nel modulo.
1. Seleziona un'attività nel campo Attività di processo.
2. Seleziona un tipo nel campo Tipo di variabile.

Puoi scegliere Input, Output oppure Meta.
3. Specifica la tua variabile nel campo Variabile.

Nota:  Reference ID is a Meta variable type.

4. Fai clic su Applica.
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3. Fai clic su Salva.
You have now configured the Human Task in your AARI process.

Add Filter Task to AARI process
You can add a Filter Task to configure the settings.
1. Aggiungi l'opzione Attività di filtro al processo trascinando l'elemento dal pannello Attività.

Il filtro attività applica un filtro alla variabile di processo.
Es.: Ricevi una tabella come output di un modulo e l'output ha una colonna Approvato che contiene
i dati Sì o No nelle righe, il filtro attività sarà in grado di recuperare solo le righe con Sì come output
del filtro attività.

2. Dal pannello Attività di filtro, esegui queste operazioni:
a) Immetti un nome nel campo Nome elemento.
b) Inserisci il nome dell'attività nel campo Nome visualizzazione attività.

Il nome dell'attività appare nell'interfaccia Web come riferimento.
c) Facoltativo:Seleziona la casella di controllo Nascondi questa attività .

Dopo il completamento dell'attività, Attività di filtro non viene visualizzata dall'utente
nell'interfaccia Web.
Per visualizzare l'attività nascosta, seleziona la casella di controllo Visualizza attività nascoste
nella pagina di visualizzazione delle attività dell'interfaccia Web.

d) Immetti una variabile nel campo Variabile da filtrare.
e) Nel campo Tipo filtrato, seleziona un'opzione.

Ad esempio, per una variabile del dizionario, è possibile scegliere le opzioni Controlla ogni
coppia chiave-valore nel dizionario o Controlla l'intero dizionario.

f) Nel campo Criterio di filtro, seleziona una condizione.
Dopo aver selezionato una condizione, specifica i campi Variabile sorgente, Operatore e
Valore di destinazione.

3. Fai clic su Salva.
You have now configured the Filter Task in your AARI process.

Add Process Task to AARI process
You can add a Process Task to configure the settings.
1. Aggiungi l'opzione Attività di processo al processo trascinando l'elemento dal pannello Attività.
2. Dal pannello Attività di processo, esegui queste operazioni:

a) Immetti un nome nel campo Nome elemento.
b) Inserisci il nome dell'attività nel campo Nome attività.

Il nome dell'attività viene visualizzato nell'interfaccia Web come riferimento.
c) Facoltativo:Seleziona la casella di controllo Nascondi questa attività agli utenti.

Dopo il completamento dell'attività, Attività di processo non viene visualizzata dall'utente
nell'interfaccia Web.
Per visualizzare l'attività nascosta, seleziona la casella di controllo Visualizza attività nascoste
nella pagina di visualizzazione delle attività dell'interfaccia Web.

d) Seleziona Cartella pubblica o Cartella privata, quindi sfoglia e seleziona il processo.
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e) Nel campo Tag privacy dati, immetti un testo o una variabile per generare un output
personalizzato nascosto.

f) Seleziona la casella di controllo in Valori di input e specifica una variabile.
1. Seleziona un'attività nel campo Attività di processo.
2. Seleziona un tipo nel campo Tipo di variabile.

Puoi scegliere Input, Output oppure Meta.
3. Specifica la tua variabile nel campo Variabile.

3. Fai clic su Salva.
You have now configured the Process Task in your AARI process.

Add Document Validation to AARI process
You can add a Document Validation Task to configure the settings.
1. Add the Document Validtation Task option to the process by dragging the element from the Task

panel.
2. From the Document Validtation Task panel, perform these steps:

a) Immetti un nome nel campo Nome elemento.
b) Inserisci il nome dell'attività nel campo Nome attività.

The task name appears in the web interface as a reference.
c) Facoltativo:Seleziona la casella di controllo Nascondi questa attività agli utenti.

After task completion, the Document Validtation Task is not displayed to the user in the web
interface.
Per visualizzare l'attività nascosta, seleziona la casella di controllo Visualizza attività nascoste
nella pagina di visualizzazione delle attività dell'interfaccia Web.

d) Facoltativo:Seleziona la checkbox Assegnazione automatica di questa attività a. Puoi
selezionare le seguenti opzioni dal menu a discesa:
• L'utente che ha creato la richiesta: L'attività viene automaticamente assegnata all'utente

che crea questa richiesta nell'interfaccia Web.
• L'utente che apre quest'attività: L'attività viene assegnata automaticamente all'utente che

apre l'attività nell'interfaccia Web.

e) Specify the ID in the Document ID field.
f) Facoltativo:Nel campo Tag privacy dati, immetti un testo o una variabile per generare un

output personalizzato nascosto.
Seleziona la casella di controllo in Valori di input e specifica una variabile.
1. Seleziona un'attività nel campo Attività di processo.
2. Seleziona un tipo nel campo Tipo di variabile.

Puoi scegliere Input, Output oppure Meta.
3. Specifica la tua variabile nel campo Variabile.

3. Fai clic su Salva.
You have now configured the API Task in your AARI process.
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Add an End Point to AARI process
You can add an end point to close your AARI process.
You can add the End point by dragging the End process or Go to from the End point panel to your
process.
• Dall'End point:pannello Termina processo, esegui queste operazioni:

a) Scegli il tipo nel campo Stato finale del processo.
Puoi scegliere tra Completato, Non riuscito e Annullato.

b) Facoltativo:Specifica un nome nel campo Aggiorna titolo richiesta.
c) Facoltativo:Aggiungi un messaggio nel campo Visualizza messaggio.

Il messaggio visualizzato immesso viene mostrato nell'ultima fase dell'attività, nella visualizzazione
della richiesta.

d) Fai clic su Applica.
e) Fai clic su Salva per salvare il processo.

• Dall'End point:vai sul pannello Vai a ed esegui queste operazioni:
a) Nell'opzione Seleziona attività di destinazione, specifica l'attività scegliendo Attività bot o

Attività umana.
b) Seleziona la casella di controllo Ignora impostazione assegnazione attività e dal menu a

discesa puoi scegliere Annulla assegnazione attività o Assegna attività all'utente che ha
creato la richiesta.
A seconda della scelta, l'attività non viene assegnata oppure l'utente che crea la richiesta può
visualizzare automaticamente l'attività assegnata nell'interfaccia Web.

c) Fai clic su Salva per salvare il processo.

AARI variable types
Data flow (workflow engine) is the core part of a process that moves data between each task. Tasks
require variables in order to run properly and three types of variables are available: input, output, and
meta-type variables.

Variable types

Inserisci Users can use this type of variable in the Process
Composer to return values that went “in” a task.

Output Users can use this type of variable in the Process
Composer to return values that went “out” a task.

Meta Users can use this type of variable in the Process
Composer to return high-level information about the
request of a task.
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Variable entities

The following entities can hold variables:

Richiesta Requests can only hold meta-type variables and
have the following form: $<meta variable
 name>]$

This meta-type variable value is from the request.

Attività Tasks can hold three types of variables (input,
output, meta) and have the following forms:
• $<task>.<input|output>[<variable

 name>]$: This variable value is read from the
task input or output.

• $<task>.<meta variable name>$: This
meta-type variable value is read from the task.

Date time variables

Nome Entities Descrizione

createdOn Request, Task Shows the date when the request or task was
created.
Esempio: $createdOn$ or
$Approval_Task.createdOn$

updatedOn Request, Task Shows the date when the request or task was
last updated.
Esempio: $updatedOn$ or
$Approval_Task.updatedOn$

Dictionary variables

Nome Entities Descrizione

assignedTo Attività Shows information about the user who is
assigned to the task.
Dictionary key: {id}, {username}, {email}

Example: $Approval_Task.assignedTo$

createdBy Richiesta Shows information about the user who created
the request.
Dictionary key: {id}, {username}, {email}

Example: $createdBy$
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Number variables

Nome Entities Descrizione

executionCount Attività Shows the number of times the task was run.
Example: $Name_Bot.executionCount$

id Request, Task Shows the numerical ID of a request or task.
Esempio: $id$ or $Approval_Task.id$

assignedTo{id} Attività Shows the numerical ID of the user who is
assigned to the task.
Example: $Approval_Task.assignedTo{id}$

createdBy{id} Richiesta Shows the numerical ID of the user who created
the request.
Example: %createdBy{id}$

String variables

Nome Entities Descrizione

status Attività Shows the label of the button clicked (action) for
a human task or the bot return code for a bot
task (equal to failed when the bot fails).
Esempio: %Approval_Task.status$ or
$Name_Bot.status$

title Request, Task Shows the title of the request or task.
Esempio: %title$ or %Approval_Task.title$

type Richiesta Shows the task type (equal to BOT for bot tasks
and FORM for human tasks).
Example: %Task.type$

assignedTo{username} Attività Shows the username of the user who is assigned
to the task.
Example: $Approval_Task.assignedTo{username}$

createdBy{username} Richiesta Shows the username of the user who created
the request.
Example: $createdBy{username}$

assignedTo{email} Attività Shows the email of the user who is assigned to
the task.
Example: $Approval_Task.assignedTo{email}$
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Nome Entities Descrizione

createdBy{email} Richiesta Shows the email of the user who created the
request.
Example: $createdBy{email}$

Use an Output variable
Users can create an output variable that is applicable for any process in order to display the output of a
child process in the parent process.
Once a user has created a process in the Process Composer, they can create an output variable that can
be called in the end process.
• Create an output variable:

a) Navigate to the Output variables section.
b) Click Show.
c) Fai clic sull'icona col segno più (+).

The Create variable window appears for your to create a new variable.
d) Specify the name of the variable in the Name field (ex: output).
e) Select your variable type in the Type field (ex: String).
f) Facoltativo: Specify the variable information in the Description field.
g) Facoltativo: Specify a default variable in the Default value field.

In this step you need to insert a variable.
a. Select a source in the Variable source field (ex: botTask).
b. Select Output as a Variable type option.
c. Select a variable in the Variable field (ex: output).
d. Click Yes, insert to confirm your changes.

h) Fai clic su Crea.
You have now created a new output variable! This output variable is located in the User-defined
variables in the Output variables section.

• Edit or delete an existing output variable:
a) Navigate to the Output variables section.
b) Select the three dots icon next the user-defined output variable (ex: output).
c) Facoltativo: Select the Delete variable to delete the current variable.
d) Select the Edit variable to edit the current variable.

The Edit variable window now prompts for you to add any new changes to your current variable.
e) Click Apply to save your changes.

You have now modified an existing output variable.

Behaviors supported in the Process Composer
Process Composer tasks, logic conditions, and end points now support copy, paste, and cut from the bot
editor. This also includes the ability for users to double-click and to replace items on the canvas.
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Elementi

Copy Use CTRL + C to copy the data from the task.
Incolla Use CTRL + V to paste the copied data in your

task.
Taglia Use CTRL + X to copy and remove data from your

task.
Double-click to add Double-click a task to add data to it.

Copy behaviors

When you copy a task in the canvas, these behaviors will occur:

Task types Behavior

• Attività del bot
• Attività umana
• Filtra attività
• Document Validation Task
• Se
• Else if
• End process
• Vai a

Properties are retained in the clipboard.

Else Task is not retained in the clipboard.

Paste behaviors

When you paste a task in the canvas, these behaviors will occur:

Task types Node selected Behavior

• Attività del bot
• Attività umana
• Filtra attività
• Document Validation

Task
• Coppia If/Else

Nessuno Task is attached to the last node located before
the end point (End process or Go to).

• Attività del bot
• Attività umana
• Filtra attività
• Document Validation

Task
• Coppia If/Else

• End process
• Vai a

Task is attached to the last node placed before
the end point (End process or Go to).
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Task types Node selected Behavior

• Attività del bot
• Attività umana
• Filtra attività
• Document Validation

Task
• Coppia If/Else

• Attività del bot
• Attività umana
• Filtra attività
• Document Validation
• Se
• Else if
• Else

Task is attached to the node.

• End process
• Vai a

• Attività del bot
• Attività umana
• Filtra attività
• Document Validation
• Se
• Else if
• Else
• Nessuno

Paste is not allowed or disabled.

• End process
• Vai a

• End process
• Vai a

Task replaces the selected node.

Else if • Se
• Else if

Task is added as a new Else if node in the same
line as the If or Else if and located in the last
position before the Else.

Else if • Attività del bot
• Attività umana
• Filtra attività
• Document Validation
• Termina processo
• Nessuno

Task is not added to the canvas because this
action is invalid.

Cut behaviors

When you cut a task in the canvas, these behaviors will occur:

Task types Behavior

• Attività del bot
• Attività umana
• Filtra attività
• Document Validation Task

Task is removed from the canvas by deletion but the clipboard
retains task with all the properties .

• Se
• Else if

Task is removed from the canvas by deletion but the clipboard
retains task with all the properties. All child nodes are deleted
from the canvas.

© 2023 Automation Anywhere. All rights reserved.     2146



    Automation Anywhere - Crea

Task types Behavior

Else Task is not removed or retained in the clipboard.

• End process
• Vai a

Task is removed from the canvas by deletion but the clipboard
contains task with all the properties.

Double-click to add behaviors
When you double-click to add in the canvas, these behaviors will occur:

Task types Node selected Behavior

• Attività del bot
• Attività umana
• Filtra attività
• Document Validation

Task
• Coppia If/Else

Nessuno Task is attached to the last node located before
the end point (End process or Go to) of the
main branch (farthest left).

• Attività del bot
• Attività umana
• Filtra attività
• Document Validation

Task
• Coppia If/Else

• End process
• Vai a

Task is attached to the last node located before
the end point (End process or Go to).

• Attività del bot
• Attività umana
• Filtra attività
• Document Validation

Task
• Coppia If/Else

• Attività del bot
• Attività umana
• Filtra attività
• Document Validation
• Se
• Else if
• Else

Task is attached to the selected node.

• End process
• Vai a

• Attività del bot
• Attività umana
• Filtra attività
• Document Validation
• Se
• Else if
• Else
• Nessuno

Double-click is not allowed or disabled.

• End process
• Vai a

• End process
• Vai a

Task replaces the selected node.
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Task types Node selected Behavior

Else if Se Task is added as a new Else if node in the same
line as the If or Else if and in the last position
before the Else.

Else if • Attività del bot
• Attività umana
• Filtra attività
• Document Validation
• Else if
• Termina processo
• Vai a
• Nessuno

Task is not added to the canvas because this
action is invalid.

Eliminare un processo AARI
Un amministratore AARI o un utente con autorizzazione Elimina da pubblica può eliminare un processo
AARI dall'area di lavoro pubblica.
Durante l'eliminazione di un processo, tieni a mente le seguenti considerazioni:
• È possibile eliminare i processi che hanno richieste aperte.

Dopo l'eliminazione di un processo, non è possibile accedervi anche se le richieste sono ancora presenti.
I bots pianificati possono ancora essere eseguiti, ma l'invio dei moduli non è possibile. Se si ripubblica lo
stesso processo, è possibile ripristinare le vecchie richieste e creare nuovamente le autorizzazioni per il
team.

• È impossibile eliminare processi estratti.

1. Accedi a Control Room come amministratore AARI o utente Bot Creator.
2. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
3. Seleziona il processo che desideri eliminare, apri il menu delle azioni (puntini di sospensione verticali)

e fai clic su Elimina processo.
È necessario eliminare prima il processo per poter eliminare i bots o i moduli all'interno del processo.

4. Seleziona Sì, elimina per confermare.
Quando il processo viene eliminato dall'area di lavoro pubblica, viene rimosso dalla pagina di gestione
dei processi nell'interfaccia Web. Inoltre, se il processo era già assegnato a un utente o a un team
AARI, dopo l'eliminazione del processo dall'area di lavoro pubblica, l'accesso viene rimosso.

Eseguire un processo AARI
In the Control Room, as a Bot Creator, you can run a process from the Process Composer in the private
workspace.
Tieni presente quanto segue:
• Quando il processo viene eseguito nell'area di lavoro privata, il Bot Creator può creare una richiesta e

immettere i dati nel modulo iniziale.
Nell'area di lavoro privata, i bots vengono eseguiti sul dispositivo predefinito del Bot Creator.
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• Le richieste create dall'area di lavoro privata possono essere visualizzate solo dall'utente che crea la
richiesta.
L'amministratore AARI non può visualizzare i processi eseguiti dall'area di lavoro privata nella pagina di
gestione dei processi.

1. Log in to the Control Room as a Bot Creator user.
2. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
3. Fai clic sul nome del processo.
4. When the process opens in the Process Composer, click Run .

Viene visualizzata una finestra in cui viene richiesto il modulo iniziale.

Check in an AARI process
Check in an Automation Anywhere Robotic Interface (AARI) process to the public workspace from the
private workspace to make it available for other users.
• È necessario disporre di una licenza Bot Creator.
• You must be assigned a custom role with the following permissions:

• Required: Check-in and check-out permission
• Facoltativo: Create folder permission
• Facoltativo: View packages permission

• To check in a process with dependent folders and files, ensure you have the following:
• Create folder permission.

If you are checking in a process from your private workspace and if the folder in which the process
is present does not yet exist in the public workspace, you must have the create folder permission to
successfully check in the process.

• Check-in permission on the dependency folder.

Importante:  If a bot is checked out, edited, and checked in again, the changes to the bot are
reflected immediately. Whereas, if you do the same for forms, the changes to forms are only
reflected when the entire process is checked in again.

1. Log in to the Control Room as a Bot Creator user.
2. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
3. Select the process you want to check in, open the actions menu (vertical ellipsis), and click Check in

process.
4. In the Check in Process window, add your comment and click Check in.

The process appears in the same folder structure in the public workspace.

Check out an AARI process
Check out an Automation Anywhere Robotic Interface (AARI) process from the public workspace to create
an editable copy of the process.
• Ensure you have the Bot Creator license to check out a process to your private workspace.
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• To check out a process with dependent folders and files, you must have the following:
• Create folder permission
• Check-out permission on the dependency folder

1. Log in to the Control Room as a Bot Creator user.
2. Nello spazio di lavoro pubblico, fai clic su Bot > I miei bot.

Viene visualizzata la pagina I miei bot con l'elenco di cartelle o file contenenti i processi.
3. Select the process, open the actions menu (vertical ellipsis), and click Check out process.

The process appears in the same folder structure in the private workspace.

Importazione di un processo AARI
Puoi importare un processo Automation Anywhere Robotic Interface (AARI) da un Control Room all'altro.
• Assicurati che i seguenti diritti siano abilitati per i processi di importazione:

• Autorizzazione del processo di importazione
• Crea autorizzazione cartella, se necessario
• Archivia autorizzazione
• Gestisci autorizzazione pacchetto

• Il percorso della directory di elaborazione fa distinzione tra maiuscole e minuscole. Assicurati quindi
che i percorsi di esportazione e importazione utilizzino lo stesso tipo di carattere maiuscolo o minuscolo
nella Control Room per evitare errori di esecuzione dell'elaborazione.

In questa attività, il processo richiesto è già stato esportato e viene inviata un'e-mail con un collegamento
al file zip contenente il package da importare.
Qualsiasi processo esportato in precedenza si trova nell'archivio pubblico e deve essere importato e
archiviato in modo che possa essere distribuito dal nuovo Control Room.
The imported process will be available in the public repository.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Fai clic su Importa bot, sfoglia e seleziona il processo da importare.

Nota:  Questa opzione si applica attualmente sia ai bots che ai processi.

3. Seleziona l'opzione per importare un processo nell'area di lavoro privata o pubblica.
4. Imposta l'opzione per l'importazione del processo in base al fatto che una versione precedente del

processo risieda nella posizione di destinazione.
Durante l'importazione, se un file esiste già, puoi scegliere di saltare il processo durante l'importazione
o sovrascrivere il processo e il file esistenti.

5. Fai clic sull'icona Importa bot.
6. Fai clic su Archivia.

Una volta completato, il processo importato viene inserito nell'archivio pubblico ed è pronto per la
distribuzione dalla nuova Control Room.

Dipendenze del processo di importazione
Quando importi un processo AARI potrebbero verificarsi problemi per cui l'importazione potrebbe
non funzionare come previsto. Questo argomento illustra gli scenari per eseguire correttamente
un'importazione.
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Panoramica

Per questi scenari, un processo Padre ha delle dipendenze con un processo Figlio e un modulo Test,
e deve eseguire un'importazione dall'Ambiente A all'Ambiente B. L'obiettivo è quello di importare
correttamente dall'Ambiente A all'Ambiente B.
Parametri
• Il processo Padre usa i processi Figlio ed entrambi usano il modulo Test nell'Ambiente A.
• Esporta il file zip Solo figlio che contiene il processo Figlio e il modulo Test.

Nota:  Devi esportare manualmente i file appropriati.

• Esporta il file zip Solo padre che contiene il processo Padre e il modulo Test.
• Export Parent-and-Child zip file that contains Parent process, Child process, and Test form.

Scenario A (Caso preferibile)
1. L'Ambiente B non contiene file.
2. Importa il file zip Solo figlio nell'Ambiente B; i file del processo Figlio e del modulo Test ora

saranno presenti nell'archivio.
AARI riceve un evento di importazione in blocco dei file del processo Figlio e del modulo Test e un
nuovo processo chiamato Processo figlio viene creato correttamente.

3. Importa il file zip Solo padre nell'Ambiente B, i file del processo Padre e del modulo Test ora
saranno presenti nell'archivio.
AARI riceve un evento di importazione in blocco dei file del processo Padre e del modulo Test; poiché
è presente il Processo figlio in AARI, il Processo padre viene creato correttamente.

4. La tua importazione è riuscita in quanto il Processo figlio e il Processo padre vengono creati in
AARI.

In questo scenario, l'importazione dall'Ambiente A all'Ambiente B è riuscita in quanto il file zip Solo
figlio è stato importato prima del file zip Solo padre, quindi il Processo figlio e Processo padre sono
stati creati correttamente in AARI.
Questo è lo scenario migliore per un'importazione riuscita.
Scenario B (Caso condizionale)
1. L'Ambiente B non contiene file.
2. Importa il file zip Solo padre nell'Ambiente B, i file del processo Padre e del modulo Test ora

saranno presenti nell'archivio.
AARI riceve un evento di importazione in blocco dei file del processo Padre e del modulo Test; poiché
il Processo figlio non è presente, non è possibile creare un Processo padre.

3. Importa il file zip Solo figlio nell'Ambiente B; i file del processo Figlio e del modulo Test ora
saranno presenti nell'archivio.
AARI riceve un evento di importazione in blocco dei file del processo Figlio e del modulo Test e un
nuovo processo chiamato Processo figlio viene creato correttamente.
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4. Importa di nuovo il file zip Solo padre con l'opzione Sovrascrivi file esistenti in selezionata
nell'Ambiente B; i file del processo Padre e del modulo Test saranno quindi sovrascritti nell'archivio.
AARI receives a bulk import event of Parent process and Test form files, since Child Process now
exists in AARI, then Parent Process is now successfully created.

Importante:  Se l'opzione Sovrascrivi file esistenti in non è selezionata, non viene generato alcun
evento di importazione in blocco, poiché i file del processo Padre e del modulo Test sono già presenti
nell'archivio, quindi il Processo padre non può essere creato in AARI.

5. La tua importazione è riuscita in quanto il Processo figlio e il Processo padre vengono creati in
AARI.

In questo scenario, l'importazione dall'Ambiente A all'Ambiente B può non riuscire se il file zip Solo
padre è stato importato prima del file zip Solo figlio, poiché il Processo padre può essere creato solo
se sono presenti le dipendenze richieste dal Processo figlio, e poiché il Processo figlio non è presente
nell'archivio, il Processo padre non può essere creato.
Per aggirare questo problema, l'utente può importare di nuovo il file zip Solo padre con l'opzione
Sovrascrivi file esistenti in selezionata per sovrascrivere l'archivio esistente, solo dopo che il Processo
figlio è stato creato, per creare correttamente il Processo padre. Questa è un'operazione riuscita
condizionata, solo se l'opzione Sovrascrivi file esistenti in è stata selezionata dall'utente, se questa
opzione non è stata selezionata, il Processo padre non può essere creato.
Per evitare questo problema, l'utente dovrebbe ricorrere allo Scenario A per un'operazione di
importazione riuscita.
Scenario C (Caso peggiore)
1. L'Ambiente B non contiene file.
2. Import Parent-and-Child zip file into Environment B, files that contains Parent process, Child

process, and Test form will now exist in the repository.
AARI riceve un evento di importazione in blocco dei file del processo Padre, del processo Figlio e
del modulo Test. Tuttavia, poiché le relazioni del processo Padre e del processo Figlio non sono
note dall'evento di importazione in blocco, il processo Padre potrebbe prima essere elaborato. Dal
momento che il Processo figlio non esiste, non riesce a creare un Processo padre.

3. La tua importazione non riesce in quanto il Processo figlio e il Processo padre non sono stati
creati in AARI.

In questo scenario, l'importazione dall'Ambiente A all'Ambiente B non riesce perché quando il file zip
Padre e figlio viene importato l'evento di importazione in blocco non capisce la relazione tra il processo
Padre e il processo Figlio. L'evento di importazione in blocco potrebbe elaborare il processo Padre prima
del processo Figlio, il che significa che il Processo padre non può essere creato visto che il Processo
figlio non esiste, quindi in AARI non viene creato alcun nuovo processo.
Per evitare completamente questo problema, l'utente dovrebbe ricorrere allo Scenario A per
un'operazione di importazione riuscita.

Export an AARI process
You can export an Automation Anywhere Robotic Interface (AARI) process from one Control Room to
another.
• Only processes within the public workspace can be exported. To export a process, check in the process

into the public workspace.
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• Ensure that you have the correct role and permissions to export the process, including the View
package permission.

• To receive the link to the exported package through email, enable SMTP.
Impostazioni del server di posta elettronica alla pagina 1502

• To export the process from one Control Room to another, both Control Rooms must be the same
version.

The Control Room maintains a maximum of 10 GB of historical export files in the download directory. Files
are deleted on a first-in/first-out basis in order to maintain this threshold.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click the Export bot, browse the public directory, and select the process to export.

Nota:  Questa opzione si applica attualmente sia ai bots che ai processi.

The selected process as well as the required dependencies are displayed.
3. Fai clic su Avanti.

The process and its dependencies are ready for export and displayed in the Review Dependencies
window.

4. Fai clic su Avanti.
All related packages are displayed.

5. Select the necessary packages associated with the process to export.
You can select Exclude process packages to remove all packages from the export.

6. Fai clic su Esporta bot e file.
If you have configured SMTP, an email is sent, which contains a link to the zip file of the exported
package.
If you have not configured SMTP, perform the following steps to access the link to the zip file of the
exported package:
a) Accedi ad ATTIVITÀ > Cronologia.
b) Search and view the historical activity of the exported package.
c) Fai clic su Scarica file zip esportato.

A link to download the zip file is displayed.

7. Use the link to download the zip file and save it to a location for importing it to another Control Room.

Import the process to an Control Room.

Parametri URL
Questo argomento ti aiuta consente di fare riferimento ai parametri URL per gli elementi supportati.

Panoramica

You can call a specific AARI process using its ID and pass parameters through the URL to populate the
initial forms based on the form field ID. This method of population is also supported for initial forms in the
iFrame widget for AARI Integrations.
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Importante:  Gli elementi supportati che possono costruire parametri URL sono gli elementi Data,
Numero, Bot testo, Ora.

Nota:  Il valore dell'URL sovrascriverà sempre il valore predefinito dei campi modulo.

Formato dei dati: per alcuni elementi ci sono formati di dati che possono essere accettati; questi formati
di dati sono i seguenti:
• Gli elementi Casella di testo, Area testo e Rich Text Editor accettano i dati di tipo Stringa
• L'elemento Numero accetta i dati di tipo Doppio.
• Gli elementi Data e Ora accettano gli elementi i dati di tipo (ora locale) data RFC 8601 (es.:

2021-06-10T00:00:00.000)
• Gli elementi Pulsante di opzione ed Elenco a discesa accettano i dati di tipo Stringa
• L'elemento Casella di controllo accetta i dati di tipo Stringa.

Mappatura dei parametri: per alcuni elementi, la mappatura dei diversi parametri è la seguente:
• Elemento Casella di testo, Area testo e Rich Text Editor

• ID elemento mostra il valore dopo che l'ID dell'elemento diventa l'elemento predefinito o il valore
di input.

• Esempio:
• TextBox1=MyValue
• TextArea2=MyLoooooooooongValue
• RichTextEditor3=AnUnformattedString

• Elemento Numero
• ID elemento mostra il valore dopo che l'ID dell'elemento diventerà l'elemento predefinito o il valore

di input.
• Esempio: Number2=123.99

• Elementi Data e Ora
• ID elemento mostra il valore dopo che l'ID dell'elemento diventerà l'elemento predefinito o il valore

di input.
• Esempio:

• Date1=2021-06-10T00:00:00.000
• Time0=2021-06-10T23:59:17.000

• Elementi Pulsante di opzione ed Elenco a discesa
• ID elemento mostra il valore dopo che l'ID dell'elemento diventerà l'elemento predefinito o il valore

di input.
• Esempio:

• RadioButtonGroup3=TheDefaultOption
• Dropdown0=TheDefaultOption

• Elemento Casella di controllo
• ID elemento mostra il valore dopo che l'ID dell'elemento diventerà l'elemento predefinito o il valore

di input.
• Esempio: CheckBoxGroup1_1=TheOption2
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Delimitatore: puoi usare il simbolo & tra i parametri

Proprietà dell'elemento password
L'elemento Password è ora disponibile per l'interfaccia web. Questo argomento mostra le funzioni chiave
dell'elemento.

Panoramica

L'elemento Password ti permette di aggiungere campi password ai moduli che possono essere elaborati
nell'interfaccia web. Questo elemento è caratterizzato da comportamenti specifici per l'uso nell'interfaccia
web.
I comportamenti sono i seguenti:
• Il valore del campo password è crittografato quando l'utente invia un modulo (modulo iniziale o come

parte di un'Attività umana).
• Quando un altro utente accede allo stesso modulo dopo l'invio (vista in sola lettura del modulo iniziale o

Attività umana), non può visualizzare il campo della password perché è crittografato.
• Dato che i valori del campo password sono crittografati, non possono essere usati nella condizione If/

Else di un processo.
• Solo i valori crittografati del campo password sono memorizzati nel database. I valori decrittografati non

vengono memorizzati.
• Quando fai passare il valore del campo password crittografato attraverso un input di variabile

credenziale a un bot all'interno del processo, il valore del campo password crittografato viene
decrittografato dal bot durante la distribuzione utilizzando una chiave istantanea dall'archivio
credenziali. Non è richiesta nessun'altra configurazione.

Quando si crea un modulo e si usa questo elemento password, l'elemento è simile all'elemento Casella di
testo, con l'eccezione che gli input di testo in questi campi ora sono mascherati.
Proprietà: l'elemento password avrà queste proprietà chiave del modulo
• ID elemento

• Questo campo può essere modificabile o sovrascrivibile dall'utente che ha creato il modulo
• Il campo assume un valore predefinito unico (ad es. il valore predefinito potrebbe essere

password1)

Nota:  Bot Creator può fare riferimento a questo campo ed è inteso per uso interno.

• Etichetta elemento
• Questo campo può essere modificabile o sovrascrivibile dall'utente che ha creato il modulo
• Si può impostare un'etichetta predefinita (ad es. Password)

• Le opzioni per rendere i campi password obbligatori o di sola lettura.

Distribuisci processi
AARI on the web interface provides a dedicated workspace to organize processes, create requests, and run
and view tasks. Managers can create new teams and manage their teams' roles and deployment of tasks.

© 2023 Automation Anywhere. All rights reserved.     2155



    Automation Anywhere - Crea

You can access AARI from the Automation 360 home page by clicking the
Explore AARI link which provides a shortcut to the AARI web interface.

The checked-in processes are available on the web interface and can be assigned to the teams so that the
team members can create requests and complete tasks.
The three main components involved in deploying a process are as follows:
• Team management alla pagina 2157
• Process management alla pagina 2158
• Request management alla pagina 2159

Deployment workflow

The following workflow describes the steps involved in deploying a process by using the web interface:
1. Creare un team AARI e assegnare i ruoli ai membri alla pagina 2164.
2. Assegnare un team AARI a un processo alla pagina 2166.
3. Crea una richiesta e completa un'attività alla pagina 2163.

Altre attività

Depending on the requirement, you can also perform the following tasks:
• As an AARI manager, you can either assign or unassign tasks to your team members.

Assign or unassign a task alla pagina 2167.
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• To clear the memory space, as an AARI user, manager, or admin, you can delete the requests that are
no longer required.
Delete a request alla pagina 2164.

• To make process selection easier at the time of request creation, as an AARI user or manager, you can
view, pin, or search for your assigned processes.
View and search for a process alla pagina 2167.

• As an AARI user, to quickly search for a specific request created, you can filter and search for that
request.
Filter and search for a request alla pagina 2168.

• As an AARI user, when you have many tasks created from multiple requests, you can filter and search
for a specific task.
Filtrare e cercare un'attività alla pagina 2170.

• You can edit your process in the Process page of the web interface.
Configure an AARI process alla pagina 2175

• As an AARI admin, you can edit bots to set parameters, enable virtual window, and assign teams to
bots.
Configure an AARI bot alla pagina 2174

Concetti correlati
AARI web interface users alla pagina 2113
Various users are involved in AARI on the web interface and each user contributes in different ways to help
automate the business requirements.
Proprietà dell'ID di riferimento alla pagina 2159
L'ID di riferimento è una chiave di riferimento univoca che facilita l'identificazione dei processi e delle
richieste correlate. L'ID di riferimento è anche diverso per i team, i processi e i bot.

Team management
Team management is an essential function of AARI in the web interface. La base dell'assegnazione della
richiesta e del processo dipende dalla configurazione del team.

Panoramica

The team configurable in AARI helps business managers to define the following aspects:
• How a request can be created
• How a request is visible to the other users
• Who can read, update, or delete requests

Team structure

A team contains users with specific team roles—admin, owner, and member. The admin has the ability to
modify their team. By default, the AARI manager is the admin of their team. They can create new teams,
manage existing teams, assign team roles (admin, owner, member) to members, and add members to
their team. As an admin, an AARI manager can add other admins to their teams. A team can have more
than one admin but must have at least one admin. To access a process and create new requests, the AARI
manager must request the AARI admin to assign the AARI manager's team to a process.
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An AARI admin can also simultaneously add multiple users with similar roles (custom role) to the AARI
team. The custom role in the Control Room is aligned with a team in AARI on the web, and the behavior of
the enhanced team setup is as follows:
• The users added with the custom role are assigned a Member role within the team. This role cannot

be changed to Owner or Admin.
• You cannot view these users added with the custom role in the Users tab of the Manage > Team

page.
• If a user is added through the custom role and also added manually to the team, their role in the team

will be the same as the role assigned to them manually. For example, if the user is a Member, they will
continue to have the Member role whereas if the user is an Owner, they will be assigned the Owner
role in the team.

• If the user is no longer part of a custom role, the user will also not be a part of the team.

For example, create a custom role (aari_role_finance) in the Control Room and add the required users
(aari_user1, aari_user2, aari_mngr1) to this role. You can now add this custom role, aari_role_finance,
to a team in AARI on the web, and the users associated with this role are automatically added to the
team. The team role of the users (aari_user1, aari_user2, aari_mngr1) is Member. The team role of these
users cannot be changed from Member to either Admin or Owner. If aari_user2 is added as a part of
aari_role_finance and also added manually through the Users tab and the role is Owner, then the team
role of this user is retained as Owner.

Team types

Ogni team è configurato in base a un tipo di team (condiviso o privato) e, a seconda di tale tipo, le
richieste che possono essere visualizzate e a cui possono accedere i membri di quel team possono
cambiare.
• Shared: All the requests can be viewed by admins, owners, and members of that team.
• Private: Requests can be viewed only by the users creating those requests and the owner and admin

of the team.

The team roles are based on the Control Room role assigned to the user. Each team role has a subset of
permissions and actions that can be performed by that role. These sets of permissions vary between the
shared and private team types.
Concetti correlati
AARI web interface users alla pagina 2113
Various users are involved in AARI on the web interface and each user contributes in different ways to help
automate the business requirements.

Process management
A process contains human tasks and bot tasks. The AARI teams can use the process to automate their
tasks by creating requests.
The AARI admin performs the global process management tasks. The AARI admin can view the checked-in
processes from the Control Room and assign teams to a process for request creation.
You can view your requests on the Processes page. For easy access to a specific process, you can
sort the processes by name in ascending or descending order and toggle the pinning of a process. The
responsive view of the Processes page adjusts the display to your screen size. To guide with your team
assignment, you can also reference the team from which a request is created by referring to the team
name added in the process tile on the Processes page.
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Request management
A request must be created to automate processes to complete assigned tasks. Members of a team create
requests and complete the corresponding tasks.
Le richieste devono sempre essere create all'interno di un team. This ensures that the teams assigned to
the same process cannot see each other's data anymore. By default, an AARI user, selected as an owner or
member of their team, can create requests because their role has the AARI user license, which enables
them to access the web interface and create requests.
The structure of request creation is as follows:
• An AARI user (team owner or member) can access and view all the processes that are assigned to a

team on the Processes page.
• The AARI user must provide all the required information in an initial form.
• The bots and human tasks run in the request view page, which contains high-level details of the

tasks.
• The task information is displayed in the Requests page, for the AARI user to verify.
• The AARI user can view their requests on the Requests page. They can manage or sort their existing

requests by using a filter.
• A request can be created by either a user or a bot on the Edit Process page. If the request is created

by a user, the process is displayed on the Processes page. If the request is created through a bot, the
user cannot create a request or view the process.

Proprietà dell'ID di riferimento
L'ID di riferimento è una chiave di riferimento univoca che facilita l'identificazione dei processi e delle
richieste correlate. L'ID di riferimento è anche diverso per i team, i processi e i bot.

Panoramica

L'obiettivo principale dell'ID di riferimento è quello di aiutare l'utente a identificare rapidamente tutti i
processi associati e il numero di richieste create da un processo.
Richieste
Un ID di riferimento è creato da una Chiave di processo, un input di testo unico, che un utente può
inserire quando modifica il processo. Quando l'utente configura la chiave di processo, crea un prefisso che
corrisponde al suo processo.
Miglioramenti chiave:
• La colonna Riferimento nella pagina Richieste mostra i numeri degli ID di riferimento (ad es. 2-42,

98-10, MAIN-5).
• La Chiave di processo e il numero di iterazioni della richiesta aiutano l'utente a identificare la

coerenza sequenziale tra il numero di richieste di un dato processo (ad es. un processo Finanza con la
chiave di processo FIN e il numero di nuove richieste mostra FIN-1, FIN-2, FIN-3, FIN-10).

Miglioramenti URL:
• L'URL Richieste è ora cambiato in entity/ref/:ref da entity/:id.
• L'utente può accedere direttamente alle sue richieste se inserisce l'ID di riferimento (es.: /aari/#/

requests/all#/requests/ref/2-34)
• Se l'utente apre una richiesta utilizzando l'ID richiesta, ora l'URL esegue il reindirizzamento utilizzando

Riferimento. Per esempio, supponiamo che l'ID richiesta sia 896 e il Riferimento sia 2-34 per
una richiesta. Se l'utente visualizza la richiesta tramite l'ID richiesta (/aari/#/requests/all#/
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requests/896), l'URL esegue il reindirizzamento utilizzando il Riferimento (/aari/#/requests/
all#/requests/2-34).

Scenario: creare una chiave di processo per visualizzare l'ID di riferimento
1. Modifica un Beta per creare una Chiave di processo chiamata ALPHA.
2. Crei più richieste dal processo Beta.
3. Per ogni richiesta creata dal file Beta, la chiave di processo ALPHA itererà una volta.
4. Accedi alla pagina Richieste e visualizza la colonna Riferimento.
5. La colonna Riferimento mostra la colonna ALPHA-1, ALPHA-2, ALPHA-3; questo è l'ID di

riferimento.
6. Ora puoi visualizzare l'ID di riferimento per tutti i processi correlati.

Bot/Processo/Team
Per Bot, Processo e Team, la funzione è diversa rispetto a una Richiesta. L'ID richiesta di un
ambiente precedente è ora sostituito dall'ID di riferimento; questo per migliorare l'esperienza del singolo
tenant per fornire una sequenza logica a un numero di riferimento.
Miglioramenti URL:
• La pagina Modifica processo mostra ora un URL aggiornato (es.: /aari/#/manage/process/

ref/96) dove l'utente può accedere direttamente a un processo quando inserisce l'ID di riferimento.
• La pagina Modifica team mostra ora un URL aggiornato (es.: /aari/#/manage/team/ref/123)

dove l'utente può accedere direttamente a un team quando inserisce l'ID di riferimento.

Modifiche all'aggiornamento in AARI dalla versione A360.21 o versioni
successive
A partire dalla versione A360.21, è stato modificato il funzionamento del lavoro dei team in AARI
nell'interfaccia Web. La gestione avanzata dei team consente ora ai manager aziendali di definire le
modalità di creazione di una richiesta e di specificare chi può visualizzare o eliminare le richieste.
Per garantire che non ci sia discontinuità nel comportamento esistente per gli utenti che disponevano
dell'accesso a un processo o hanno creato richieste da un processo (indipendentemente dall'assegnazione
del team esistente), è necessario mantenere le seguenti condizioni:
• L'accesso dell'utente alla creazione di una richiesta per un processo specifico viene mantenuto.
• Viene mantenuto anche l'accesso dell'utente alla visualizzazione delle richieste di un processo,

indipendentemente dal team di cui faceva parte.

Come vengono modificati i team esistenti

Per mantenere l'attuale accesso ai processi e ai team correnti, i team esistenti mantengono quanto segue:
• Il processo esistente loro assegnato.
• Gli stessi membri assegnati al team.
• Il tipo di team viene configurato come condiviso. In tal modo, si garantisce che tutti i membri del team

possano visualizzare le richieste e i processi migrati.
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• I membri del team hanno uno dei seguenti ruoli del team:
• Manager AARI o amministratore AARI - Ruolo di amministratore
• Utente AARI - Ruolo di membro

Per mantenere l'accesso corrente alle richieste, vengono creati nuovi team per ogni processo e il nuovo
team dispone di quanto segue:
• I processi esistenti assegnati al team sono denominati "Team migrati per il processo X", dove X è l'ID

del processo. Ciò consente di fare riferimento ai processi migrati. Vengono creati team per i processi
esistenti con questo nome.

• Gli utenti che avevano accesso al processo in precedenza vengono assegnati a questo team,
indipendentemente dalla relativa assegnazione esistente, e il team viene assegnato al processo.

• Il tipo di team viene configurato come condiviso.
• I membri del team hanno uno dei seguenti ruoli del team:

• Manager AARI amministratore AARI
• Utente AARI

In precedenza, i manager AARI potevano creare richieste senza assegnare i processi ai team. Dopo
l'aggiornamento, i manager devono creare i team e chiedere all'amministratore AARI di assegnare i propri
team a un processo al fine di creare nuove richieste.

Importante:  Dopo il processo di migrazione e la creazione del team migrato, la creazione della richiesta
includerà due processi (uno per ogni team) da selezionare. I due processi avranno comportamenti diversi
per la visibilità della richiesta.

Esempio

Il seguente scenario illustra il funzionamento dell'aggiornamento.
Si consideri un processo denominato "Chiusura del prestito", con ID processo 47. Georges è un utente
AARI con ruolo di amministratore in Control Room.
Prima dell'aggiornamento
Due team, RU e IT, hanno accesso al processo di chiusura del prestito e la struttura del team è quella
indicata nella tabella seguente.

RU IT

Nome utente Ruolo Control Room Nome utente Ruolo Control Room

Bob Gestore AARI Grace Gestore AARI

Carol Utente AARI Steve Utente AARI

Debby Utente AARI Debby Utente AARI

Il comportamento prima dell'aggiornamento è quello indicato di seguito:
• Gli utenti del team RU possono visualizzare le richieste create dal team IT e viceversa.
• Bob e Grace possono assegnare i processi che sono stati precedentemente assegnati da Georges

rispettivamente al team RU e IT.
• Bob può gestire il team RU e, allo stesso modo, Grace può gestire il team IT, ad esempio, aggiungere

membri, assegnare processi, rinominare il team e così via.
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Dopo l'aggiornamento
I due team iniziali (RU e IT) rimangono e, inoltre, viene creato un nuovo team (denominato Team migrato
per il processo 47) durante l'aggiornamento. La struttura dei tre team è riportata nella tabella seguente:

RU IT Team migrato per il processo
47

Nome
utente

Ruolo del
team

Ruolo
Control
Room

Nome
utente

Ruolo del
team

Ruolo
Control
Room

Nome
utente

Ruolo del
team

Ruolo
Control
Room

Bob AmministratoreGestore
AARI

Grace AmministratoreGestore
AARI

Bob AmministratoreGestore
AARI

Carol Membro Utente
AARI

Steve Membro Utente
AARI

Carol Membro Utente
AARI

Debby Membro Utente
AARI

Debby Membro Utente
AARI

Debby Membro Utente
AARI

Utente
AARI

Grace AmministratoreGestore
AARI

Steve Membro Utente
AARI

Il comportamento dei team dopo l'aggiornamento è quello descritto di seguito:
• I membri del team RU non possono più visualizzare le richieste create dal team IT e viceversa.
• Poiché Debby fa parte sia del team RU che del team IT, questo utente può creare richieste in entrambi

i team. Durante la creazione della richiesta, all'utente vengono visualizzate due diverse schede di
processo.

• Le precedenti richieste create all'interno dei team RU e IT vengono trattate come se fossero state
create all'interno del team comune denominato Team migrato per il processo 47, a cui è assegnato solo
il processo Chiusura del prestito (47).

• I membri dei team RU e IT fanno tutti parte del team migrato per il processo 47 e possono quindi
accedere alle richieste precedenti. L'eliminazione del team migrato per il processo 47 cancella le
relative richieste associate, pertanto l'accesso alle precedenti richieste viene rimosso e non può essere
ripristinato.

• I membri del team RU o IT possono creare richieste all'interno del Team migrato per il processo 47 e
tali richieste sono visibili a tutti i membri del team RU e IT.

• Bob e Grace possono gestire rispettivamente il team RU e IT e gestire congiuntamente il team migrato
per il processo 47. Ciò significa che possono aggiungere membri al team, rinominare il team, rimuovere
membri dal team e così via.

• Bob e Grace possono ora visualizzare solo i processi assegnati ai propri team da Georges.

Important:  Durante l'aggiornamento, potrebbero verificarsi problemi con l'assegnazione del ruolo di
amministratore del team in modo intermittente, per cui al creatore del team viene erroneamente assegnato
il ruolo di membro anziché il ruolo di amministratore del team o ad altri membri del team viene assegnato
il ruolo di amministratore del team anziché il ruolo di membro. Dopo l'aggiornamento, l'amministratore
AARI deve sempre verificare l'assegnazione del ruolo di amministratore del team.
L'esempio seguente spiega il problema dell'assegnazione del ruolo di amministratore del team:
Prima dell'aggiornamento: Bob crea il team RU e ha il ruolo di manager AARI, mentre Carol, Debby,
Grace e Steve sono membri del team e hanno il ruolo di utenti AARI.
Dopo l'aggiornamento: A Bob viene assegnato il ruolo di amministratore del team insieme a Carol.
A Debby, Grace e Steve vengono assegnati i ruoli di membri del team. In questo caso, a Carol è stato
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erroneamente assegnato il ruolo di amministratore anziché quello di membro. L'amministratore AARI deve
verificare l'assegnazione del ruolo di amministratore del team e modificare il ruolo di Carol in membro del
team.

Crea una richiesta e completa un'attività
Un utente AARI può creare una nuova richiesta dai processi ai quali è assegnato il proprio team, inserire le
informazioni richieste in un modulo iniziale e completare le attività.
Assicurati di aver completato i seguenti passaggi:
• Fornire un ruolo Utente AAE_Robotic_Interface creato dal sistema per l'utente AARI.
• La licenza di utente AARI è stata assegnata.
• Aver effettuato l'accesso all'interfaccia web.

1. Accedi all'interfaccia Web come utente AARI.
In qualità di utente AARI, sei ora assegnato a un team con un ruolo di proprietario o membro del
team, creato dal gestore o dall'amministratore AARI.

2. Vai alla pagina Processi.
Questa pagina mostra tutti i processi disponibili a cui il team è stato assegnato dall'amministratore
AARI.

3. Seleziona un processo assegnato.
Viene visualizzato il modulo iniziale che mostra i campi obbligatori da compilare. Questi campi
provengono da elementi di forma interattivi supportati.

Importante:  I processi ora includono i nomi dei team associati al processo a cui è assegnato il team.
Il nome del team Team migrato per il processo indica che il processo è disponibile per i membri
del team che hanno già avuto accesso a tale processo, indipendentemente dall'assegnazione del team,
prima dell'aggiornamento Automation 360.

4. Completa le informazioni richieste nel modulo iniziale.
Puoi anche compilare i moduli iniziali tramite i parametri URL per gli elementi Data, Numero,
Casella di testo e Ora.

5. Opzionale: Per visualizzare la richiesta in un'altra scheda, seleziona l'opzione Apri richiesta in una
nuova scheda.

6. Fai clic su Invia per confermare le informazioni e l'avanzamento.
Facoltativamente, puoi fare clic su Annulla per annullare le modifiche.

7. Visualizza la pagina di visualizzazione della richiesta.
Il processo è ora in esecuzione e potrebbe essere richiesto di completare le attività in sospeso nelle
schede Richiesta.

8. Completa le informazioni richieste per l'attività nella scheda Richiesta.
Mentre il bot completa la sua attività, potrebbe essere richiesto di eseguire e completare le fasi
rimanenti.

9. Visualizza lo stato della richiesta.
La richiesta è ora completata.

10. Accedi a Richieste > Tutte le richieste per visualizzare tutte le richieste create nel team.
11. Opzionale: Fai clic sul pulsante Crea richiesta per creare una nuova richiesta dalla pagina Richiesta.
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Delete a request
An AARI user, manager, or administrator can delete requests that are no longer required. Deleting requests
helps clear the memory space. You can also recover a deleted request if necessary.
Assicurati di aver completato i seguenti passaggi:
• Assigned a system-created AAE_Robotic_Interface User role for the AARI user,

AAE_Robotic_Interface Manager for the AARI manager, or AAE_Robotic_Interface Admin role
for the AARI administrator.

• For the AARI user, manager, or admin:
• La licenza di utente AARI è stata assegnata.
• Provided access to AARI on the web.

Only requests that are in Aborted, Cancelled, Failed, or Completed status can be deleted.
• An AARI administrator can delete any request.

Nota:  The AARI administrator is the only user who can permanently delete requests.

• The AARI manager can delete requests of the team for which they are the owner.
• The AARI user can delete only the requests they have created.

Importante:  Files that are associated with a process is deleted when the request are deleted or are
automatically deleted after 90 days.

1. Accedi all'interfaccia web.
2. Navigate to the Request tab.
3. From the list of requests, select the request or requests you want to delete and click the delete icon.

A confirmation message appears to confirm the deletion.
4. Click Yes, delete to delete the selected requests.
5. Opzionale: To recover a deleted request or requests, perform these steps:

a) Navigate to the Recycle Bin tab.
b) Select the requests you want to recover and click the recover icon.

A confirmation message appears to confirm recovery of the request.
c) Click Yes, recover.

The requests are recovered and appear in the Requests tab.

Creare un team AARI e assegnare i ruoli ai membri
Un gestore AARI è un amministratore d team che può creare nuovi team, aggiungere membri al proprio
team e assegnare nuovi ruoli. L'amministratore AARI può anche configurare un team ma non ha un ruolo
nel team.
Assicurati di aver completato i seguenti passaggi:
• Fornito un ruolo Gestore AAE_Robotic_Interface creato dal sistema per il gestore AARI.

Nota:  In addition, the AARI manager requires the AARI license.

• Fornito un ruolo Amministratore AAE_Robotic_Interface creato dal sistema per l'amministratore
AARI.
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• Aver effettuato l'accesso all'interfaccia web.

1. Accedi all'interfaccia web come gestore AARI o amministratore.
2. Navigate to Manage > Team.

The Team page enables the AARI manager or admin to view all of their teams and provides the
option to create a new team.

3. Fai clic su Crea nuovo team.
La finestra Crea nuovo team richiede al gestore o all'amministratore AARI di inserire i dettagli del
team.

4. Immetti un nome nel campo Nome Team.
5. Opzionale: Inserisci una descrizione nel campo Descrizione.
6. Select a user from the drop-down in the Team admin field.
7. In the Request Visibility field in the General tab, select Shared or Private.

If you select the Shared option, then all the requests that are created are accessible to members of
the team. If you select the Private option, then a request will be available only to the member who
created that request and the owners and admins of the team.

8. Add members to the team by choosing one of the following options:
Opzione Fasi

Utenti a. Click the + (plus) icon. The Add members window appears. Use it to
search for members to add.

b. Search by using name, email, username, or role in the search bar.
c. Select the member from the displayed list.
d. Click Add & save. I membri vengono ora correttamente aggiunti al

team.
e. Optional:  To remove a team member, select the member and click

the trash icon.

f. Navigate to Roles next to each member name. Each member's team
role is set to Member, by default.

g. Fai clic su Membro per modificare il ruolo del team, se applicabile.
h. Select Member, Owner, or Admin to designate the team role.

Important:  Un team deve avere come membro almeno un
Amministratore. Only the AARI manager can be assigned the Admin
team role because the roles are based on theControl Room roles
assigned to the user. A team, however, can have more than one admin.

Ruoli a. Click the + (plus) icon. The Add roles window appears. Use it to
search for roles to add.

b. Search for a role in the search bar.
c. Select the role from the displayed list.
d. Click Add & save. Roles are now successfully added to the team.
e. Optional:  To remove a role, select the role and click the trash icon.
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9. Opzionale: Click the Processes or Bots tabs respectively to view the assigned processes or bots.
10. Fai clic su Chiudi.
11. Opzionale: Per modificare un team esistente, fai clic sul nome del team nella colonna Team nella

pagina Configurazione del team.
Il gestore o l'amministratore AARI possono modificare un team per aggiornarne la configurazione
oppure fai clic su Elimina per eliminare completamente il team.

Assegnare un team AARI a un processo
Un amministratore AARI può configurare processi nell'interfaccia Web e assegnare i team a un processo
per la creazione di una richiesta. Essi accedono all'interfaccia Web per visualizzare e gestire i processi nella
pagina Configurazione del processo.
Assicurati di aver completato i seguenti passaggi:
• Fornito un ruolo Amministratore AAE_Robotic_Interface creato dal sistema per l'amministratore

AARI.
• Aver effettuato l'accesso all'interfaccia web.

Per l'amministratore AARI, la funzione principale è quella di assegnare i team a un processo.
1. Log in to the web interface as an AARI admin.
2. Accedi a Mangage > Configurazione del processo

La pagina Configurazione del processo consente all'amministratore AARI di visualizzare tutti i
processi di archiviazione dalla Control Room e di assegnare i team a un processo.

3. Fai clic su un processo.
Viene visualizzata la finestra Modifica processo che mostra le informazioni correlate al processo,
come il nome del processo, la descrizione, i tag e i team.

4. Modifica il campo Nome processo, se necessario.
5. Opzionale: Inserisci una descrizione nel campo Descrizione.
6. Fai clic su Aggiungi tag nel campo Tag per aggiungere i tag al processo.

Viene visualizzata la finestra Aggiungi tag per cercare i tag da aggiungere.
7. Effettua una ricerca con la descrizione di un tag nella barra di ricerca.
8. Fai clic sul nome per confermare il tag.
9. Fai clic su Aggiungi.
10. Seleziona l'utente del pianificatore dal menu a discesa nel campo Pianificatore.

Nota:  L'opzione Pianificatore globale è selezionata per impostazione predefinita se per nessun
processo non è impostato un pianificatore.

11. Seleziona le opzioni per utente (impostazione predefinita) o per bot nel campo Creazione della
richiesta.

Importante:  Se è selezionata l'opzione per utente, i processi saranno visibili nella pagina Processi
per tutti gli utenti AARI (proprietari o membri del team). If the by bot option is selected, then the
request is created by a bot or another process using the Process Task in the Process Composer. È
necessario selezionare un team nel campo Team predefinito per ricevere la richiesta creata dal
bot, per le richieste create da quel team.

12. Fai clic sull'icona + (più) per aggiungere team al processo.
Viene visualizzata la finestra Aggiungi team per cercare i team da aggiungere.

13. Cerca un team nella barra di ricerca.
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14. Fai clic sul nome per confermare il team.
15. Fai clic su Aggiungi.

Il team viene aggiunto correttamente al processo.
16. Opzionale: Per rimuovere un team, fai clic sull'icona cestino accanto al nome del team.
17. Fai clic su Salva.

Assign or unassign a task
The Automation Anywhere Robotic Interface (AARI) manager and user can assign specific tasks to their
team. They can also unassign tasks.
Assicurati di aver completato i seguenti passaggi:
• Fornito un ruolo Gestore AAE_Robotic_Interface creato dal sistema per il gestore AARI.
• Fornire un ruolo Utente AAE_Robotic_Interface creato dal sistema per l'utente AARI.
• Avere accesso a AARI sul web.

Managers can assign tasks to all members who have access to a process. Users can assign tasks to other
users in the same team. Managers and users can unassign tasks.
1. Log in to the web interface as an AARI manager.
2. Navigate to the Tasks tab.
3. Select a task from the list.
4. Naviga su

• Unassigned
Tasks are unassigned by default.

• Assign to me
This option assigns the task to the current user.

5. Select the user.
The task is now assigned.

6. Opzionale: Select Unassigned.
The task is now unassigned.

View and search for a process
The AARI user can view, pin, or search their assigned processes.
Assicurati di aver completato i seguenti passaggi:
• Fornire un ruolo Utente AAE_Robotic_Interface creato dal sistema per l'utente AARI.
• La licenza di utente AARI è stata assegnata.
• Avere accesso a AARI sul web.

1. Accedi all'interfaccia Web come utente AARI.
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2. Click Create request from the home page and choose from these options:
Opzione Fasi

View a process View your assigned process in the Select a process window.

Importante:  A list of processes is available in the All tab by
default and are assigned to your team by the manager.

View a pinned process a. Click the pin icon.
b. Navigate to the Pinned tab.
c. View your pinned process.

Search for a process a. Click Create request from the home page.
b. Navigate to the search bar.
c. Enter your keyword.

The search bar dynamically searches your processes for
common keywords. You can also search for tags.

d. View the searched process.

Filter and search for a request
When an AARI user has created many requests, they can quickly search for a specific request in the
Requests page.
Assicurati di aver completato i seguenti passaggi:
• Fornire un ruolo Utente AAE_Robotic_Interface creato dal sistema per l'utente AARI.
• La licenza di utente AARI è stata assegnata.
• Avere accesso a AARI sul web.

Follow these steps to quickly search or filter your requests:
1. Accedi all'interfaccia Web come utente AARI.

You are now in your home page, where you can view your requests.
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2. Navigate to the Requests page and choose from these options:
Opzione Fasi

Ordina a. Fai clic su una colonna.
Puoi scegliere tra: Status, Reference,
Process,Team, Request title Created , Updated
or Tags.
Come impostazione predefinita, la colonna è ordinata
in ordine crescente.

b. Facoltativo: fai clic nuovamente sulla stessa
colonna.
The column is now sorted to descending order.

c. View your sorted requests.

Ricerca a. Fai clic su Stato (impostato come predefinito).
You can search by Request title, Reference,
Process, Tags, Data Privacy Tags (AARI Admin
only), and Team.

b. Search for your request.
La barra di ricerca esegue una ricerca dinamica delle
parole chiave comuni.
• Inserisci il titolo nel campo Titolo richiesta.
• Inserisci la chiave di riferimento nel campo

Riferimento.
• Enter a process name in the Process field.
• Enter a tag name in the Tags field.
• Enter a team name in the Team field.
• Facoltativo: inserisci la query nel campo Tag

privacy dei dati.

Nota:  Questa opzione è disponibile solo per
l'amministratore di AARI. L'amministratore
può aggiornare il campo e gestire qualsiasi
informazione sulla privacy dei dati.

c. Facoltativo: fai clic su x per cancellare le parole
chiave cercate.

d. View the searched requests.
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Opzione Fasi

Filtro a. Fai clic su Stato (impostato come predefinito).
You can filter by selecting from the drop-down menu.

b. Seleziona dal menu a discesa.
You can choose from Completed, Failed,
Cancelled, and Open.

c. Facoltativo: Click x to clear filtered keywords.
d. View your filtered requests.

Data a. Seleziona il campo Crea data o Data di
aggiornamento.
Appare la finestra dell'intervallo di date.

b. Seleziona la data corrente o specifica qualsiasi data
nei campi Da e A.

c. Fai clic su Invia.
d. View your requests by the creation or modified dates.

Filtrare e cercare un'attività
Quando un utente AARI ha creato diverse attività, può cercare rapidamente un'attività specifica nella
pagina Attività.
Assicurati di aver completato i seguenti passaggi:
• Fornire un ruolo Utente AAE_Robotic_Interface creato dal sistema per l'utente AARI.
• La licenza di utente AARI è stata assegnata.
• Avere accesso a AARI sul web.

Segui questi passaggi per cercare o filtrare rapidamente le tue attività:
1. Accedi all'interfaccia Web come utente AARI.

Ora sei nella tua home page, dove puoi visualizzare le tue attività.
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2. Navigate to the Tasks page and choose from these options:
Opzione Fasi

Ordina a. Fai clic su una colonna.
Puoi scegliere tra: Status, Task Name,
Assignee,Team, Request title, Reference, Task
Created, Task Updated.
Come impostazione predefinita, la colonna è ordinata
in ordine crescente.

b. Facoltativo: fai clic nuovamente sulla stessa
colonna.
La colonna è ora ordinata in ordine decrescente come
impostazione predefinita.

c. Visualizza le tue attività ordinate.

Ricerca a. Fai clic su Stato (impostato come predefinito).
You can search by Task Name, Request title,
Reference, Data Privacy Tags (AARI Admin only),
Assignee, and Team.

b. Cerca la tua attività.
La barra di ricerca esegue una ricerca dinamica delle
parole chiave comuni.
• Inserisci il nome dell'attività nel campo Nome

attività
• Inserisci il titolo nel campo Titolo richiesta.
• Inserisci la chiave di riferimento nel campo

Riferimento.
• Inserisci un nome assegnatario nel campo

Assegnatario.
• Inserisci un nome del team nel campo Team.
• Facoltativo: inserisci la query nel campo Tag

privacy dei dati.

Nota:  Questa opzione è disponibile solo per
l'amministratore di AARI. L'amministratore
può aggiornare il campo e gestire qualsiasi
informazione sulla privacy dei dati.

c. Facoltativo: fai clic su x per cancellare le parole
chiave cercate.

d. Visualizza le attività cercate.
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Opzione Fasi

Data a. Seleziona il campo Crea data o Data di
aggiornamento.
Appare la finestra dell'intervallo di date.

b. Seleziona la data corrente o specifica qualsiasi data
nei campi Da e A.

c. Fai clic su Invia.
d. Visualizza le tue attività in base alle date di creazione

o di modifica.

Filtri preimpostati nella vista
Tabella

a. Passa alla scheda Vista tabella (impostata come
predefinita)

b. Fai clic su Le mie attività completate, Le mie
attività in sospeso o Attività non assegnate.

c. Visualizza le tue attività filtrate.

Filtro nella vista Tabella a. Fai clic su Stato (impostato come predefinito) o
Tipo.

b. Seleziona dal menu a discesa.
Per Stato puoi scegliere tra In sospeso,
Annullata, e Completata.
Per Tipo puoi scegliere tra Modulo e Convalida.

c. Visualizza le tue attività filtrate.
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Opzione Fasi

Filtro nella vista Dettagli a. Accedi alla scheda Vista dettagli.
b. Fai clic su Filtro.
c. Nella finestra di filtro dedicata che si apre, configura i

contenuti selezionando da queste opzioni del filtro:
• Scegli un filtro preimpostato da Le mie attività

completate, Le mie attività in sospeso e
Attività non assegnate.

• Seleziona una data nei campi Crea data o Data
di aggiornamento.
Puoi selezionare la data corrente o specificare
qualsiasi data nei campi Da e A.

• Seleziona uno stato nell'opzione Stato.
Puoi scegliere In sospeso, Annullata, e
Completata.

• Inserisci un nome dell'attività nel campo Nome
attività.

• Inserisci un nome nel campo Titolo richiesta.
• Enter a name in the Created by field.
• Inserisci la chiave di riferimento nel campo

Riferimento.
• Seleziona un tipo nell'opzione Tipo.

Puoi scegliere Modulo e Convalida.
• Inserisci un nome nel campo Assegnatario.
• Facoltativo: inserisci la query nel campo Tag

privacy dei dati.

Nota:  Questa opzione è disponibile solo per
l'amministratore di AARI. L'amministratore
può aggiornare il campo e gestire qualsiasi
informazione sulla privacy dei dati.

d. Nell'elenco delle attività, puoi filtrare le attività con
più opzioni di ordinamento:
1. Fai clic su Attività creata (impostata come

predefinita).
2. Select in the Sort By field from Status, Task

Name, Reference, Title, and Task Created
options.

3. Seleziona nel campo Ordine dagli ordini
Ascendente (impostato come predefinito) e
Discendente.

e. Facoltativo: fai clic su x per cancellare le parole
chiave o i tag del filtro personalizzato.

f. Visualizza le tue attività filtrate.
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Configure an AARI bot
Questo compito mostra come modificare un bot per impostare i parametri e gestire i membri del team.
1. Accedi all'interfaccia web.
2. Accedi a Gestisci > Bot.
3. Fai clic su un bot disponibile.

In questo modo si apre la pagina Modifica Bot nella scheda Generale.
4. Specifica un nome nel campo Nome visualizzato bot.
5. Fai riferimento al nome file nel campo Nome file bot

Nota:  Il campo è disattivato e non può essere modificato in quanto ti consente di fare riferimento al
nome di questo file bot.

6. Fai riferimento all'URI nel campo Uri

Nota:  Il campo è disattivato e non può essere modificato in quanto ti consente di fare riferimento
all'URI di questo bot.

7. Opzionale: inserisci una descrizione del bot.
8. Opzionale: Select the Run this bot in virtual window check box.

This option enables the Picture-in-Picture (PIP) feature in Microsoft Windows. This feature enables
attended users to run bots in AARI Assistant on a virtual desktop window, while they continue to work
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on other applications. For more information on AARI Assistant, see Informazioni su AARI Assistant alla
pagina 2180.
Attended users can also use the PIP feature to run attended bots from the iFrame widget in their web
applications, see Embedded Automation alla pagina 2218.

Importante:  Microsoft Windows 8, Microsoft Windows Server 12, or any of the later versions are
required for virtual window. Here are some of the existing limitations of using the PIP feature:
• Another instance of your current browser cannot be used on Windows Desktop and the virtual

window at the same time.
For example, if you are using an instance of Google Chrome on your Windows Desktop, the same
cannot be used in the virtual window. In order to use Google Chrome in the virtual window, ensure
you close this browser on your Desktop.

• When a virtual window is initiated, you might be logged out of your connected Global Protect
software. However, the TaskBot will continue to run in the virtual window.

• Applications that allow single log in are restricted to the corresponding main or virtual windows.
• After a bot starts, it runs in the virtual window and is completely independent of the main instance.

9. Opzionale: seleziona Elimina bot per eliminare questo bot.

Importante:  Questa opzione eliminerà permanentemente il bot.

10. Fai clic sulla scheda Team.
Questa pagina le permette di gestire i membri del team.

11. Fai clic sul pulsante Aggiungi (+).
Compare la pagina Aggiungi team.

12. Seleziona un team disponibile.
13. Fai clic su Aggiungi e salva per confermare la scelta.

Ora un team è assegnato a questo bot.
14. Opzionale: seleziona un team e fai clic sul pulsante Elimina (cestino) per rimuovere un team.
15. Opzionale: Seleziona la barra di ricerca e filtra per Team, Descrizione e Richiedi visibilità da

Privato o Condiviso.
16. Fai clic su Chiudi.

Le impostazioni vengono salvate automaticamente.

Configure an AARI process
Questa attività mostra come modificare un processo per creare una chiave di processo, impostare un team
predefinito e abilitare l'opzione per eliminare un processo.

1. Accedi all'interfaccia web.
2. Accedi a Gestisci > Processo.
3. Fai clic su un processo disponibile.

In questo modo si apre la pagina Modifica processo nella scheda Generale.
4. Specifica un nome nel campo Nome processo.
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5. Facoltativo: aggiungi una descrizione nel campo Descrizione.
6. Inserisci una chiave cliente (se applicabile) nel campo Chiave di processo.

Importante:  La chiave di processo deve essere lunga da uno a cinque caratteri e in ordine
alfabetico. La chiave di processo può essere definita solo una volta, e dopo che la chiave di processo è
stata definita, non può essere modificata successivamente dall'utente.

7. Aggiungi tag al processo nella sezione Tag del campo.
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8. In the Tags field:
a) Click the Tags field.
b) Specify your tags with unique keywords, such as Cases or Reports.
c) Select the Add as new option from the drop-down to add a new tag.

The keyword will automatically generate a new tag if it does not exist. The search result is
displayed in real time.

d) (Optional) Select an existing tag from the drop-down.
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e) (Optional) Select the trash bin icon to delete your tags in the field.

Nota:  Only the AARI admin can view and create tags.

9. Specifica il team nel campo Team predefinito.
Per impostazione predefinita, il primo team che viene aggiunto al processo viene automaticamente
impostato come team predefinito. Puoi cambiare il team selezionandolo dal menu a discesa.

Importante:  Un team predefinito non può essere eliminato da un processo. Per rimuovere un team
predefinito (ad es. Team 1), l'amministratore deve impostare un altro team (ad es. Team 2) come
team predefinito, quindi rimuovere il team originale (ad es. Team 1) dal processo.

Es.: puoi selezionare Direttore reclutamento nel menu a discesa.
10. Scegli tra per utente e per bot nel campo Creazione della richiesta.
11. Nel campo Conservazione delle richieste:

• Seleziona Disabilitato, Immediato o Personalizzato dal primo menu a discesa per specificare
se la richiesta completata viene spostata dalla pagina Richiesta a Cestino.
For example, you can select Disabled to prevent your requests from being moved to the Recycle
bin or select Immediate for all current completed requests to be moved without delay.

Nota:  When you select the Immediate option, it can take a maximum time of one hour before
the request is moved to the Recycle bin.

• Seleziona Immediato o Personalizzato dal secondo menu a discesa per specificare il numero di
giorni dopo i quali le richieste vengono eliminate definitivamente nel Cestino.
Es.: puoi selezionare l'opzione Custom e specificare 30 per indicare che dopo trenta giorni la
richiesta viene eliminata nel Cestino.

• Seleziona l'opzione della casella di controllo per far sì che le richieste aperte vengano spostate nel
Cestino.

12. Fai clic su Chiudi.
Le impostazioni vengono salvate automaticamente.

Bot setup
The AARI admin can manage and assign bots to a team of attended Bot Runner users, for them to view
bots in the AARI Assistant.
The main purpose of this feature is to improve the bot assignment for attended Bot Runner users, to
enable them to access only the bots that are assigned to their team by an AARI admin.
This helps control which users can view or use a bot. However, if an attended Bot Runner user is not apart
of any team, they will be able to view and access all bots in the AARI Assistant.
For the AARI admin to assign a team of attended Bot Runner users to a bot, they must have view
permissions on folders containing the bot.
• The AARI admin can access the Bot Setup page in the web interface to view all bots and assign them

to a team. They can also assign multiple teams to a bot or remove teams from bots entirely.
• When new bots are added to this page, the bots can be assigned to a team of attended Bot Runner

users.
• The attended Bot Runner users can view their assigned bots in the AARI Assistant.
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• The attended Bot Runner user must have a role with access to the public folder where the bot resides.

Attended and unattended automation
The Automation Anywhere RPA Workspace provides attended and unattended automation for users to
create bots that can manage routine tasks efficiently. While users focus on critical inputs that require
manual overview or approval, bots handle tasks such as gathering information across databases, validating
data, or responding to chats.

Panoramica
Collaboration between humans and software bots is called attended automation. As attended automation
requires user supervision, it is best suited for use with smaller and more fragmented tasks. However,
some tasks within a business process do not change a lot over time and might not require extensive
user intervention, such as collecting data or retrieving information from multiple databases. When such
tasks that require little or no user judgment are configured to trigger other bots, it is called unattended
automation. Unattended automation is useful to perform privileged operations, requiring elevated
permissions and credentials.
Automation 360 offers a combination of attended and unattended automation for a complete RPA solution
with the following benefits:
• Automated integration between multiple applications or databases, reducing errors as very little user

intervention is necessary.
• Access bots in real-time through an easy to use interface.
• Users can set up or change triggers to start bots based on real-time.

Watch the following video to understand attended automation:
Concetti correlati
Using AARI on desktop alla pagina 2179
Use Automation Anywhere Robotic Interface (AARI) through your desktop to manage routine tasks such as
validating data, retrieving approvals, and managing escalations through bots.
Informazioni correlate
Using bots to solve problems

Using AARI on desktop
Use Automation Anywhere Robotic Interface (AARI) through your desktop to manage routine tasks such as
validating data, retrieving approvals, and managing escalations through bots.
The following workflow describes how to use AARI to automate and manage your tasks:
1. Create a user:

• The Control Room administrator creates a user with a Bot Creator license.
Create a user alla pagina 2684 | Licenze Automation 360 alla pagina 1010

• The user logs in to the Control Room to start building bots.
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039 | Get started building bots alla
pagina 2049
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2. Create forms using the Interactive forms package:
• Interactive forms enable you to design forms for submitting and regrouping data from various

applications.
Create a form alla pagina 2186

• Link the form to a newly created bot or an existing bot using the Bot editor interface.
Add a form to bot alla pagina 2205

3. Add triggers to the bot:
Trigger loop enables you to add triggers that can run a task automatically when certain predefined
events occur.
Adding a trigger to run a bot alla pagina 2207

Informazioni su AARI Assistant
Gli utenti Bot Runner assistiti possono utilizzare l'applicazione AARI Assistant per accedere ai bots senza
effettuare l'accesso alla Control Room.
L'amministratore della Control Room aggiunge gli utenti Active Directory (AD) selezionando il dominio AD,
fornendo dettagli sull'ambiente e assegnando ruolo e licenza del dispositivo. L'amministratore può inoltre
implementare l'RBAC Control Room specificando privilegi e autorizzazioni basati sui ruoli a livello di bots e
Bot Runner.
L'RBAC Control Room sugli utenti Bot Runner facilita l'isolamento completo in base a criteri predefiniti,
come utenti di diverse unità o reparti aziendali. Ciò include anche i privilegi applicati a livello di cartella per
isolare completamente e senza problemi i bots di un reparto da quelli di un altro.
In uno scenario tipico, l'attivazione di alcuni bots specifici per il completamento di attività importanti può
essere una delle routine quotidiane per gli utenti Bot Runner assistiti. L'intero processo di accesso alla
Control Room può richiedere molto tempo. AARI Assistant riduce notevolmente questo sforzo. Quando Bot
Agent è installato su un dispositivo, sul desktop viene creato un collegamento all'applicazione per AARI
Assistant insieme all'icona del menu Start.
Gli utenti con licenza Bot Runner assistita possono avviare questa applicazione, utilizzare le proprie
credenziali AD per accedere, esaminare l'elenco dei bots disponibili ed eseguire uno specifico bot.

Importante:  AARI Assistant application is not available for the Citizen Developer license.

Accedere a AARI Assistant
Utilizza l'applicazione AARI Assistant per eseguire direttamente i bots senza accedere alla Control Room.
• Il servizio Automation Anywhere AARI deve essere in esecuzione in Control Room per poter utilizzare

AARI Assistant.
• Questa applicazione è progettata solo per gli utenti con licenza Bot Runner assistita. Viene visualizzato

un errore di accesso se gli utenti con qualsiasi altra licenza tentano di accedere.

1. Fai clic sull'icona AARI per aprire AARI Assistant.
2. Utilizza le credenziali Automation 360 per accedere all'applicazione.

Vengono elencati tutti i bots a cui si ha accesso.
3. Opzionale: Utilizza la barra Cerca nella parte superiore per trovare un bot.
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4. Opzionale: Fai clic sulla casella di controllo Mostra solo elementi evidenziati per elencare i bots
evidenziati.
Assicurati di evidenziare (in modo simile ai preferiti) i bots più utilizzati per consentire un accesso
rapido.

5. Fai clic su Avvia per eseguire il bot.
Una volta completata con successo l'esecuzione del bot, viene visualizzato il messaggio Completato.
Non è possibile avviare un altro bot fino al completamento dell'attività.

AARI Assistant automation activities
As an attended user who runs attended bots, you can perform several automation activities using AARI
Assistant.

Automations page overview

In AARI Assistant, you can view a list of available bots for you to run in the Automations page.

© 2023 Automation Anywhere. All rights reserved.     2181



    Automation Anywhere - Crea

You can resize the page to fit your screen and have its contents automatically adjust.
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From the Automations page, you can also pin, sort, or search for bots.

Key features

Continue pending automation You can continue any pending automation that you
started from different AARI Assistant instances. If
you start an automation from one instance and then
reconnect to continue the automation on another
instance, the automation will process.
This provides a consistent automation experience
no matter which instance you use to access AARI
Assistant.

Consistent state AARI Assistant will remain in a consistent state
regardless of how many AARI Assistant instances
you use. The state will be updated to the latest
state across all AARI Assistant instances.

View and run any available bots To view and run any available bots, simple click
Start to start the automation.

View status or control bot progress in one
page

After you run a bot, you can view its progress in
real time.
You can also pause, start (resume), or stop the bot
progress.
By presenting the status and bot controls on one
unified page, this ensures consistency for each bot
run.
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Nota:  To use the bot controls, you must have the
Managed my activity permission. Otherwise, you
can view the controls only.

View detailed status You can view the details of a bot status .
For example, you can use the details to
troubleshoot the automation if an error occurs.
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Using interactive forms
Interactive forms enable you to build forms for submitting and regrouping data that is used to send and
receive information from various applications within your attended automation process.
Interactive forms provide a list of actions that you can drag into a bot as a task logic. Specific function
of each action is displayed when you hover over them. The actions within the interactive forms can be
broadly classified into the following types:

Form level actions Represented by  and used within a task logic to
manage the linked form.

Element level actions Represented by  and used to manage elements
of a form.

Watch the following video to understand how to use Interactive forms in Automation 360:

Create a form
The form builder in Automation 360 enables you to create or edit forms using various form elements
available through a browser interface. A form provides structural content with little or no changes in the
layout. You can link a form to bots that perform predefined automated tasks.
The form builder requires no additional installation over the Bot Agent. Control Room users with the Bot
Creator license can access the form builder to design a new form or edit an existing form.
This task provides an example scenario where you create a new user registration form that captures all
the necessary information. When you link this form to a bot, it can trigger a third-party application to store
user information.
The form builder includes the following features:

© 2023 Automation Anywhere. All rights reserved.     2186



    Automation Anywhere - Crea

• The title of your form can be changed with a double-click.
• You can now add elements directly to the form builder without the need to add a column for each

element. The elements will dynamically resize to fit the canvas
• You can add up to 25 elements in a form.
• The width of the elements will automatically adjust in the form builder, depending on the number of

elements that you add.
• You can also adjust the width of your elements when you click and drag a corner of an element.
• The minimum width of the element is greater than 20.

1. Nel pannello di sinistra, fai clic su Automazione.
Viene visualizzato un elenco dei moduli e dei  disponibili.

2. Click Create a form.
3. Nella pagina Crea modulo, immetti un nome per il nuovo modulo.

I processi vengono salvati nella cartella \Bots\ per impostazione predefinita. Fai clic su Sfoglia per
modificare la cartella predefinita.

4. Fai clic su Crea e modifica.
The form builder page appears with a single row Column layout.

5. Use the Properties tab on the right to update or change the form properties.
a) Enter the title in the Form title field.
b) Use the Formatting fields to set the display font or the font size of the form elements.

Nota:  Use the Font name drop-down menu to select an English-only font.
If you have used any of the supported non-English languages for the form elements, select Font
name > System default. For example, if you added an element label or text in Japanese,
select Font name > Medium for the form elements to be displayed in Japanese during the bot
runtime.

c) Use the Dimensions field to set the width and height of the form.
d) Use the Display behaviors field to set the way the form is displayed on the user desktop.
e) Opzionale: Use the Logos in footer field and select one of the following tabs:

• One Logo
Click Select File and use the Search, Browse, or Upload tabs to select an image file. The
selected file is displayed in the footer of the form during bot runtime.

• Two Logos
Click the two separate Select File options to select two image files. The selected files are
displayed in the footer of the form during bot runtime.

f) Set a variable using Hidden elements.
For example, if the registration form is linked to a Social Security Number (SSN) that cannot be
displayed to users, select the hidden element Type as Number. A user with a Bot Creator license
can then access this variable when creating a bot.
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6. Opzionale: Fai clic su Anteprima.
The form preview screen enables you to view the display resolution of the form and change the form
position on the your desktop. You can select a resolution in the Display Resolution option.

You can either enter the values for the X and Y coordinates or drag the form using the cursor to
update the corresponding X and Y coordinates dynamically.
The Make form preview centered option lets you center the form.
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7. In this scenario, drag the following elements into the form:
a) Textbox: Enter First Name in the Element label field of the first text box, and enter Last

Name in the Element label field of the second text box.
b) Numero: Enter Contact Number in the Element label field.

For a new user registration form, some of the fields such as contact number might be mandatory.
Use the Advance behaviors to make it mandatory and the Formatting option to set the input
format.

c) Radio Button: Update the Element label as Gender. Change the values for the
Radiobutton1 as Male and Radiobutton2 as Female.

d) Date: Enter Date of Birth in the Element label field.
e) Textbox: Enter Email ID in the Element label field.
f) Elenco a discesa: Update the Element label as Newsletter. Enter Daily, Weekly, Monthly,

or None in the Add dropdown content field.
In this scenario, you can use the Dropdown element to create a newsletter option for the new
user. This can be used to trigger an email based on the selected option.

g) Pulsante: Enter Submit in the Button-text (required) field.
h) Drag another Button element and enter Cancel in the Button-text (required) field.

Use the Button type drop-down menu and set this as Secondary.

8. Opzionale: Fai clic su Anteprima.
Utilizza questa funzione per visualizzare in anteprima l'aspetto del modulo in base alla risoluzione del
dispositivo di destinazione.

9. Fai clic su Salva.
Il nuovo modulo di registrazione viene creato ed è pronto per essere collegato a un bot.

Utilizzo dell'elemento Pulsante
Utilizza l'elemento Pulsante nel generatore di moduli per convalidare o annullare un modulo durante il
runtime del bot.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Trascina il Pulsante nel modulo.
4. Inserisci il nome dell'elemento nel campo Testo pulsante.
5. Opzionale: Inserisci il testo del suggerimento e la descrizione comando.
6. Utilizza il menu a discesa Tipi di pulsanti per impostare il tipo di elemento del pulsante.

Ad esempio, si considerino due pulsanti, Salva e Annulla. Utilizza Primario per salvare e Secondario
per annullare. Oppure, se vuoi che l'elemento pulsante appaia come un collegamento durante il
runtime del bot, seleziona Sottile.

7. Opzionale: Utilizza la seguente opzione Comportamento avanzato:
• Non consentire il clic sul pulsante quando questo modulo viene caricato per la

prima volta: abilita questa opzione per disattivare l'elemento pulsante quando il modulo viene
visualizzato per la prima volta durante il runtime del bot.

• Facendo clic su questo pulsante vengono convalidati tutti i campi del modulo: abilita
questa opzione per convalidare tutti i campi disponibili del modulo quando un utente fa clic su
questo elemento pulsante durante il runtime di bot.
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8. Opzionale: Fai clic su una delle seguenti opzioni:
• Ripristina: cancella tutta la personalizzazione degli elementi e imposta il valore predefinito.
• Elimina: elimina l'elemento selezionato.

9. Fai clic su Salva.

Using the Checkbox element
Use the Checkbox element in the form builder to enable users to select multiple options in a form during
bot runtime.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Drag Checkbox into the form.
4. Inserisci il nome dell'elemento nel campo Etichetta elemento.
5. Opzionale: Enter the hint text and tooltip for the check box element.
6. Use the Checkbox content fields to add multiple check boxes and enter a name for each one of

them.
For example, if you are creating a sales chart form, use this field to add three check boxes and enter
Product 1, Product 2, and Product 3.

7. Opzionale: Enable any of the following Advance behavior options:
• Select the Make field required check box to ensure users select this element during bot runtime.
• Select the Make field uneditable check box to make the element a read-only option.
• If you have multiple check boxes in the form and want a default selection during bot runtime,

select the Make default selections check box, and select the necessary option.

8. Use the Formatting field to set the vertical or horizontal layout of the check boxes.
9. Opzionale: Fai clic su una delle seguenti opzioni:

• Ripristina: cancella tutta la personalizzazione degli elementi e imposta il valore predefinito.
• Elimina: elimina l'elemento selezionato.

10. Fai clic su Salva.

Using the Date element
Use the Date element in the form builder if the user must schedule a date in the form during bot runtime.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Drag Date into the form.
4. Inserisci il nome dell'elemento nel campo Etichetta elemento.
5. Select a default date using the Default value field.
6. Opzionale: Seleziona la casella di controllo Utilizza la data del sistema locale quando il modulo

viene caricato per impostare la data del sistema come valore predefinito.
7. Select one of the following formatting options:

• Use locale date format setting: The date is displayed in the format set on the user's machine.
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• Manual input: Select the date format to be displayed from the drop-down menu.

8. Enter the hint text and tooltip for the formatting option.
9. Opzionale: Enable any of the following Advance behavior options:

• Select the Make field required check box to ensure users select this element during bot runtime.
• Select the Make field uneditable check box to make the element a read-only option.

10. Opzionale: Fai clic su una delle seguenti opzioni:
• Ripristina: cancella tutta la personalizzazione degli elementi e imposta il valore predefinito.
• Elimina: elimina l'elemento selezionato.

11. Fai clic su Salva.

Using the Document element
Use the Document element in the form builder to render a document, such as an image (.jpg) or PDF,
that you want to preview along with the form.

Nota:  Only one Document element can be used in a form.

1. Nel pannello di sinistra, fai clic su Automazione.
Viene visualizzato un elenco dei moduli e dei  disponibili.

2. Click an existing form or click Create new > Form.
Viene visualizzata la pagina del generatore di moduli.

3. Drag Document into the form.
4. Enter the correct URL or the document location address in the Default file field.
5. Use the Formatting drop-down menu to set the position of the document element in the form.
6. Opzionale: Enter a specific width for the element in the Dimensions field.
7. Opzionale: Fai clic su una delle seguenti opzioni:

• Ripristina: cancella tutta la personalizzazione degli elementi e imposta il valore predefinito.
• Elimina: elimina l'elemento selezionato.

8. Fai clic su Salva.

Using the Dropdown element
Use the Dropdown element in the form builder to provide multiple options in the form during bot runtime.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Drag Dropdown into the form.
4. Inserisci il nome dell'elemento nel campo Etichetta elemento.
5. Opzionale: Enter the hint text and tooltip for the check box element.
6. Use the Add dropdown content field to enter the items that must appear in the drop-down menu

during bot runtime.
7. Opzionale: Enable any of the following Advance behavior options:

• Select the Make field required check box to ensure users select this element during bot runtime.
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• Select the Make field uneditable check box to make the element a read-only option.
• If you have multiple items in the drop-down element and want a default selection during bot

runtime, select the Select default list item check box, and select the necessary option.

8. Opzionale: Fai clic su una delle seguenti opzioni:
• Ripristina: cancella tutta la personalizzazione degli elementi e imposta il valore predefinito.
• Elimina: elimina l'elemento selezionato.

9. Fai clic su Salva.

Using the Dynamic Area element
Use the Dynamic Area element in the form builder to display content that is not part of the form itself
during bot runtime.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Drag Dynamic Area into the form.
4. Inserisci il nome dell'elemento nel campo Etichetta elemento.
5. Use the Placeholder text field to enter the text that must appear if this element is empty during bot

runtime.
6. Immetti un'altezza specifica dell'elemento nel campo Altezza.

Il valore di dimensione predefinito è impostato su 120 e abilita una barra di scorrimento, se il
contenuto aggiuntivo supera questo valore.

7. Opzionale: Fai clic su una delle seguenti opzioni:
• Ripristina: cancella tutta la personalizzazione degli elementi e imposta il valore predefinito.
• Elimina: elimina l'elemento selezionato.

8. Fai clic su Salva.
The Dynamic Area action is available during bot runtime to render this field.
Consulta Interactive forms package alla pagina 1638.

Using the Select File element
Use the Select File element in the form builder to enable users to attach a file to the form. For example, if
the registration form requires a new user to attach a photograph, you can use this element in the form.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Drag Select File into the form.
4. Inserisci il nome dell'elemento nel campo Etichetta elemento.
5. Use the Select the format type field to set one of the following options for upload file format:

• Supported Type: If you select this option, in the Enter file formats separated by commas
field, ensure that you enter the file types that the user can upload when the bot runs. For example,
if you want to allow only .png and .jpeg file types, enter them in the Enter file formats
separated by commas field.
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• Unsupported Type: If you select this option, in the Enter file formats separated by commas
field, ensure that you enter the file types that will not be supported during upload when the bot
runs. For example, if you want to restrict users from uploading .txt and .ppt file types, enter
them in the Enter file formats separated by commas field.

6. Opzionale: Select Enable file download if you want the users to be able to download the file.
7. Opzionale: Enter the hint text and tooltip for the element.
8. Opzionale: Choose one of the following Advance behavior options:

• Select the Make field required check box to ensure users must select this element during bot
runtime.

• Select the Make field uneditable check box to set the element as a read-only option.

9. Opzionale: Choose one of the following options:
• Ripristina: cancella tutta la personalizzazione degli elementi e imposta il valore predefinito.
• Elimina: elimina l'elemento selezionato.

10. Fai clic su Salva.
When you click Preview during bot runtime, the system default application is used to display the
selected file.
For example, if Microsoft Excel is set as the default application and you use Select file to upload a
.xls spreadsheet, the selected document is displayed in Microsoft Excel when you click Preview
during bot runtime.
Users can click Browse to select a file or drag a file into the Select File element during bot runtime.

Using the Select Folder element
Use the Select Folder element in the form builder to enable users to upload a folder that contains a
specified file type during bot runtime.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Drag Select Folder into the form.
4. Inserisci il nome dell'elemento nel campo Etichetta elemento.
5. Opzionale: Select the Show list of supported files in the folder check box.

If you select this option, the supported file types are displayed below the Select folder form element
during bot runtime.

6. Enter the supported file types for this element during bot runtime.
For example, if you want to allow users to only upload folders that contain documents or text files,
enter doc and txt.

7. Opzionale: Enter the hint text and tooltip for the element.
8. Opzionale: Choose one of the following Advance behavior options:

• Select the Make field required check box to ensure users must select this element during bot
runtime.

• Select the Make field uneditable check box to set the element as a read-only option.

9. Fai clic su Salva.
Users can click Browse to select a folder or drag one into the Select Folder element during bot
runtime.
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Using the Hyperlink element
Use the Hyperlink element in the form builder if you want to assign a URL during bot runtime.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Drag Hyperlink into the form.
4. Enter the text to be displayed for the URL in the Display text field.
5. Enter the link in the URL field.
6. Use the Open in browser drop-down menu to select a browser to open the URL.

If you select Google Chrome, the URL opens in Google Chrome during bot runtime.
7. Opzionale: Enter the hint text and tooltip for the check box element.
8. Fai clic su Salva.

Using the Image element
Use the Image element in the form builder to enable users to attach an image file to the form. For
example, you can use this element to add a company logo to the form during bot runtime.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Drag Image element into the form.
4. Enter the id in the Element ID field.
5. Inserisci il nome dell'elemento nel campo Etichetta elemento.
6. Opzionale: Enter a value in the Height field to adjust the height.
7. Opzionale: Add a help text.

• Enter a text in Hint below field.
• Enter a text in the Tool tip field.

8. Use the Desktop or network path to retrieve image field to specify the image filepath
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9. Upload an image in the Select image file to upload field.

Nota:  In Automation 360 v.26, where you must specify a local image for the Image element
(Desktop or network path to retrieve image field), you must use the browse feature in the image
property to upload the image.

10. Fai clic su Salva.

Utilizzo dell'elemento Etichetta
Utilizza l'elemento Etichetta nel generatore di moduli per aggiungere un campo di sola lettura nel modulo
durante il runtime del bot.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Trascina Etichetta nel modulo.
4. Inserisci il nome dell'elemento nel campo Etichetta elemento.
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5. Fai clic sul menu a discesa Formattazione per applicare un effetto di formattazione all'elemento:
• Dimensioni carattere: imposta la dimensione del carattere.
• Enfasi: imposta l'enfasi del carattere come grassetto, corsivo e così via.
• Colore carattere: imposta il colore di visualizzazione del carattere.
• Allineamento del testo: imposta l'allineamento del testo all'interno dell'elemento.

6. Opzionale: Immetti una descrizione comando che viene visualizzata quando l'utente passa
sull'elemento.

7. Fai clic su Salva.

Using the Number element
Use the Number element in the form builder if the form must have a field that allows the user to enter
only numeric values during bot runtime.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Drag Number into the form.
4. Inserisci il nome dell'elemento nel campo Etichetta elemento.
5. Set the default value for the element.
6. Enter the minimum and maximum number of characters that users can enter in this field during bot

runtime.
7. Opzionale: Enter the hint text and tooltip for the check box element.
8. Opzionale: Enable any of the following Advance behavior options:

• Select the Make field required check box to ensure users select this element during bot runtime.
• Select the Make field uneditable check box to make the element a read-only option.

9. Use the Formatting options to enable users to enter negative values, trailing zeroes, and comma
during bot runtime.

10. Utilizza il menu a discesa Decimali per impostare il numero di posizioni decimali.
11. Utilizza il campo Caratteri speciali per immettere le etichette di prefisso e suffisso per l'elemento.
12. Opzionale: Fai clic su una delle seguenti opzioni:

• Ripristina: cancella tutta la personalizzazione degli elementi e imposta il valore predefinito.
• Elimina: elimina l'elemento selezionato.

13. Fai clic su Salva.

Using the Password element
Use the Password element in the form builder if the form must have a confidential or masked field. This
element uses the masking feature by default and Credential Vault encryption to transfer data during bot
runtime.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Drag Password to the form.
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4. Inserisci il nome dell'elemento nel campo Etichetta elemento.
5. Utilizza il campo Formattazione per ulteriori opzioni:

• Standard
• Imposta il limite di caratteri per la password utilizzando i campi Min e Max.
• Abilita opzioni di sicurezza aggiuntive per la password.

• Personalizzata
• Fai clic sull'opzione Aggiungi espressione regolare e immetti una password personalizzata

nel campo Espressione regolare.
• Facoltativo: Enter the same custom password in the Test Content field, and click Test

regular expression to verify it works correctly.

6. Opzionale: Inserisci il testo del suggerimento e la descrizione comando.
7. Opzionale: Enable any of the following Advance behavior options:

• Select the Make field required check box to ensure users select this element during bot runtime.
• Select the Make field uneditable check box to make the element a read-only option.

8. Opzionale: Fai clic su una delle seguenti opzioni:
• Ripristina: cancella tutta la personalizzazione degli elementi e imposta il valore predefinito.
• Elimina: elimina l'elemento selezionato.

9. Fai clic su Salva.

Nota:  Use the view icon in the Password field to review the password during bot runtime.

Using the Radio Button element
Use the Radio Button element in the form builder if you want to enable users to select only one of the
available options from a field during bot runtime.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Drag Radio Button into the form.
4. Inserisci il nome dell'elemento nel campo Etichetta elemento.
5. Opzionale: Enter the hint text and tooltip for the check box element.
6. Enter the names of the radio buttons that will be displayed during bot runtime.

Ad esempio, se stai creando un modulo di informazioni sul cliente, utilizza questo campo per
aggiungere due pulsanti di opzione e immettere Maschio e Femmina.

7. Enable any of the following Advance behavior options:
• Select the Make field required check box to ensure users select this element during bot runtime.
• Select the Make field uneditable check box to make the element a read-only option.
• If you have multiple radio buttons in the form and want a default selection during bot runtime,

select the Make default selections check box, and select the necessary option.

8. Use the Formatting field to set the vertical or horizontal layout of the radio buttons.
9. Opzionale: Fai clic su una delle seguenti opzioni:

• Ripristina: cancella tutta la personalizzazione degli elementi e imposta il valore predefinito.
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• Elimina: elimina l'elemento selezionato.

10. Fai clic su Salva.

Using the Rich Text Editor element
Use the Rich Text Editor element in the form builder to insert a text editor in the form that provides
various options to edit the content during bot runtime.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Drag Rich Text Editor into the form.
4. Inserisci il nome dell'elemento nel campo Etichetta elemento.
5. Set the default value for the element that must appear in the element during bot runtime.
6. Enter the minimum and maximum number of characters that users can enter in this field during bot

runtime.
7. Opzionale: Enter the height for the input area of the field and tooltip for the element.
8. Opzionale: Enable any of the following Advance behavior options:

• Select the Make field required check box to ensure users select this element during bot runtime.
• Select the Make field uneditable check box to make the element a read-only option.

9. Opzionale: Fai clic su una delle seguenti opzioni:
• Ripristina: cancella tutta la personalizzazione degli elementi e imposta il valore predefinito.
• Elimina: elimina l'elemento selezionato.

10. Fai clic su Salva.

Using the Snapshot element
Use the Snapshot element in the form builder to provide the users a screen capture option on the form
during bot runtime. The file is saved in the .jpg format.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Drag Snapshot into the form.
4. Inserisci il nome dell'elemento nel campo Etichetta elemento.
5. Opzionale: Enter the hint text and tooltip for the check box element.
6. Opzionale: Choose one of the following Advance behavior options:

• Select the Make field required check box to ensure users must select this element during bot
runtime.

• Select the Make field uneditable check box to set the element as a read-only option.

7. Enter a filepath in the Desktop path to save snapshot field where the snapshot file must be saved
during bot runtime.
Optionally, you can either allow the user to create a folder if the filepath is not available or change the
destination folder of the snapshot file.
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8. Immetti il testo del suffisso per il file delle snapshot.
For example, if this element is used to capture sales information, enter Sales. The snapshot file is
then saved with the text Sales added at the end.

9. Opzionale: Choose one of the following options:
• Ripristina: cancella tutta la personalizzazione degli elementi e imposta il valore predefinito.
• Elimina: elimina l'elemento selezionato.

10. Fai clic su Salva.
When you click Preview during bot runtime, the system default application is used to display the
snapshot file.
For example, if Microsoft Photos is set as the default application to open .jpg files, the snapshot file
is displayed in Microsoft Photos when you click Preview.

Utilizzo dell'elemento Tabella
Utilizza l'elemento Tabella nel generatore di moduli, per inserire una tabella personalizzabile nel modulo
che può essere utilizzato per popolare i dati durante il runtime di bot.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Trascina la Tabella nel modulo.
4. Inserisci il nome dell'elemento nel campo Etichetta elemento.
5. Opzionale: Inserisci il testo del suggerimento per l'elemento.

Ad esempio, immetti Visualizza dettagli pazienti esterni, se la tabella viene utilizzata
per acquisire un elenco di pazienti esterni.

6. Utilizza il campo Righe prima dello scorrimento per immettere il numero minimo di righe che
l'elemento della tabella deve avere prima di aggiungere una barra di scorrimento durante il runtime del
bot.

7. Aggiungi o rimuovi il numero totale di colonne.
8. Fai clic su Impostazioni colonna per ulteriori opzioni.
9. Nella pagina Impostazioni colonna, fai clic sul menu a discesa Tipo di elemento modulo per

impostare il tipo di elemento.
Ad esempio, se selezioni Elenco a discesa, utilizza il campo Aggiungi contenuti di elenco a
discesa per immettere gli elementi che devono essere visualizzati nel menu a discesa durante il
runtime del bot.

10. Opzionale: Fai clic su Rendere la larghezza delle colonne uguale.
11. Opzionale: Seleziona una delle seguenti opzioni Comportamento avanzato per attivarle:

• Rendi la tabella non modificabile: Abilita una vista di sola lettura durante il runtime di bot.
• Includi azioni tabella: consente agli utenti di aggiungere, rimuovere o modificare le righe della

tabella durante il runtime del bot.
Se utilizzi le operazioni della tabella per eliminare tutte le righe da una tabella e, quindi, aggiungi
una nuova riga, le colonne e le righe della tabella appaiono non allineate. Trascina e ridimensiona
una colonna per ripristinare l'allineamento.

• Abilita filtro colonne: consente agli utenti di cercare e filtrare il contenuto per tutte le colonne
disponibili durante il runtime del bot. Questo migliora la ricerca del contenuto a cui fanno
riferimento i valori delle colonne.

12. Fai clic su Salva.
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Using the Text Area element
Use the Text Area element in the form builder to insert a text field in the form for users to enter
alphanumeric characters during bot runtime.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Drag Text Area into the form.
4. Inserisci il nome dell'elemento nel campo Etichetta elemento.
5. Use the Default value field to enter the default text to be displayed in the element.
6. Enter the minimum and maximum number of characters that users can enter in this field during bot

runtime.
7. Enter the height for the input area of the field.
8. Opzionale: Enter the hint text and tooltip for the check box element.
9. Opzionale: Enable any of the following Advance behavior options:

• Select the Make field required check box to ensure users select this element during bot runtime.
• Select the Make field uneditable check box to make the element a read-only option.

10. Opzionale: Fai clic su una delle seguenti opzioni:
• Ripristina: cancella tutta la personalizzazione degli elementi e imposta il valore predefinito.
• Elimina: elimina l'elemento selezionato.

11. Fai clic su Salva.

Using the Text Box element
Use the Text Box element in the form builder to insert a text box in the form.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Drag Text Box into the form.
4. Inserisci il nome dell'elemento nel campo Etichetta elemento.
5. Enter the default text that must appear in the element.

For example, if this field is used in a registration form, enter First name, which is displayed during
bot runtime.

6. Utilizza il campo Formattazione per ulteriori opzioni:
• Standard

Imposta il limite di caratteri utilizzando i campi Min e Max.
• Personalizzata

• Fai clic sull'opzione Aggiungi espressione regolare e immetti un testo personalizzato nel
campo Espressione regolare.

• Facoltativo: Inserisci lo stesso testo personalizzato nel campo Verifica contenuto e fai clic
su Verifica espressione regolare per verificarne il corretto funzionamento.

7. Opzionale: Enter the hint text and tooltip for the element.
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8. Enable any of the following Advance behavior options:
• Select the Make field required check box to ensure users select this element during bot runtime.
• Select the Make field uneditable check box to make the element a read-only option.
• Select the Mask data check box if you want the field to be masked by special characters when the

user enters data during bot runtime.

9. Opzionale: Fai clic su una delle seguenti opzioni:
• Ripristina: cancella tutta la personalizzazione degli elementi e imposta il valore predefinito.
• Elimina: elimina l'elemento selezionato.

10. Fai clic su Salva.

Using the Time element
Use the Time element in the form builder to set the time in the form during bot runtime.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click an existing form or click Create new > Form.

Viene visualizzata la pagina del generatore di moduli.
3. Drag Time into the form.
4. Inserisci il nome dell'elemento nel campo Etichetta elemento.
5. Select a default time using the Default value field.
6. Opzionale: Select the Use the local system time when form is first displayed check box to set

your system time as the default value.
7. Use one of the following formatting options:

• Set the time to 12 Hours or 24 Hours format.
• Inserisci il testo del suggerimento e la descrizione comando.

8. Opzionale: Enable any of the following Advance behavior options:
• Select the Make field required check box to ensure users select this element during bot runtime.
• Select the Make field uneditable check box to make the element a read-only option.

9. Opzionale: Fai clic su una delle seguenti opzioni:
• Ripristina: cancella tutta la personalizzazione degli elementi e imposta il valore predefinito.
• Elimina: elimina l'elemento selezionato.

10. Fai clic su Salva.

Aggiunta di regole agli elementi di un modulo
Add conditional actions, such as If, And/Or, and Then, to various elements in a form by using rules.
Per gli elementi Checkbox e Pulsante di opzione, le regole sono attivate solo se le corrispondenti
impostazioni predefinite sono selezionate. Ad esempio, se un modulo ha due opzioni che si escludono a
vicenda, come Sì e No, le regole associate a queste opzioni vengono attivate solo se si seleziona una delle
due opzioni.

Attenzione:  Le regole non sono supportate per i seguenti elementi:
• Area dinamica
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• Collegamento ipertestuale
• Immagine
• Seleziona file
• Seleziona cartella
• Snapshot
• Tabella

Nota:  The change label action in the form rules now applies to the Button element. This form
rules will automatically apply to the button where you set the rules. The rules editor is now
applicable to the Table element. The rules editor and conditions applies for each individual
columns while any actions you set are applied for each row in the row level.

Considera uno scenario in cui stai creando un modulo di iscrizione/registrazione di un utente. Puoi
aggiungere una regola a uno degli elementi del modulo per abilitare un'opzione per accedere come utente
esistente o per registrare un utente per la prima volta.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Click Create new > Form.
3. Nella pagina Crea modulo, immetti un nome per il nuovo modulo.

I processi vengono salvati nella cartella \Bots\ per impostazione predefinita. (Facoltativo) Fai clic su
Scegli per modificare la cartella predefinita.

4. Fai clic su Crea e modifica.
5. Trascina i seguenti elementi nel modulo:

• Elenco a discesa: Nel campo Etichetta elemento inserisci "Seleziona il tipo di utente" e nel
campo Aggiungi contenuti di menu a discesa aggiungi "Utente esistente" e "Nuovo utente".

• Casella di testo: Aggiungi due elementi e nominali "Nome utente" e "Registrati".
• Password: Aggiungi un elemento.
• Pulsante: Aggiungi due elementi e nominali come "Salva" e "Annulla".

6. Nel riquadro di destra, fai clic su Regole del modulo > Aggiungi regola.
Puoi usare questa opzione per aggiungere regole agli elementi del modulo. In questo scenario,
aggiungi due regole.
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7. Per Regola1, aggiorna i seguenti campi:
La Regola 1 viene applicata quando un utente esistente cerca di accedere. Se un utente fa clic su
Seleziona il tipo di utente > Utente esistente, la casella di testo Registrati viene resa non
disponibile. Utilizza il menu Se per impostare le seguenti condizioni:
a) Seleziona il tipo di utente come condizione elemento nel primo menu a discesa
b) La scelta è nel secondo menu a discesa
c) Utente esistente nel terzo menu a discesa

Nota:  Le condizioni If sono supportate sui seguenti elementi:
• Elenco a discesa
• Checkbox
• Pulsante di opzione
• Data
• Ora
• Collegamento ipertestuale

Utilizza il menu Then per impostare le azioni corrispondenti:
a) The Register text box in the first drop-down menu

Tutti gli elementi disponibili nel modulo su cui sono supportate le regole sono elencati in questo
campo. For the Dropdown element in the Then menu, you can use the Assign option to
append or overwrite values at bot runtime.

b) Disabilita nel secondo menu a discesa

8. On Rule1, click the vertical ellipsis

( )
for the following options:
• Aggiungi regola di seguito: Aggiungi una nuova regola di seguito a Regola1.
• Regola duplicata: Aggiungi un duplicato della Regola1.
• Elimina regola: Elimina la Regola1.

If you added more than one rule, the following additional options are enabled to toggle the rules:
• Sposta su
• Sposta giù
• Sposta in alto
• Sposta in basso
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9. Per la Regola2, aggiorna i seguenti campi:
La Regola 2 è applicata per un utente che accede per la prima volta. Se un utente fa clic su Seleziona
il tipo di utente > Nuovo utente, le caselle di testo Nome utente e Password sono rese non
disponibili. Utilizza il menu Se per impostare le seguenti condizioni:
a) Seleziona il tipo di utente come condizione elemento nel primo menu a discesa
b) La scelta è nel secondo menu a discesa
c) Nuovo utente nel terzo menu a discesa

Utilizza il menu Then per impostare le azioni corrispondenti:
a) The User name text box in the first drop-down menu
b) Disabilita nel secondo menu a discesa
c) The Password text box in the third drop-down menu
d) Disabilita nel quarto menu a discesa

10. Opzionale: If you want to interchange the sequence of these two rules, drag Rule1 below Rule2 or
Rule2 above Rule1.
You can also click the ellipsis (…) next to Add rules to select one of the following options:
• Collapse all: Collapses the rules. Is enabled only if you have expanded any of the available rules.
• Expand all: Expands the rules.

11. Fai clic su Salva.
Il nuovo modulo di registrazione viene creato ed è pronto per essere collegato a un bot.

Add a form to bot
Adding an existing form to a bot enables users to collaborate with bots. Use the necessary action items to
create a bot and build a task logic.
This task describes a scenario where you want to design a bot that triggers an existing New User
Registration form. A Hot key preset trigger starts the bot. An existing form that is linked to the bot is
displayed where the user enters the information.
• If the user clicks Submit, a User Agreement form is displayed.
• If the user clicks Cancel, User registration is canceled message is displayed and the bot is

terminated.

1. Nel pannello di sinistra, fai clic su Automazione.
Viene visualizzato un elenco dei moduli e dei  disponibili.

2. Fai clic su Crea nuovo > Bot.
3. Inserisci un nome per il bot.

Tutti i bots sono memorizzati nella cartella \Bots. Fai clic su Sfoglia per modificare la cartella.
4. Fai clic su Crea e modifica.

The bot builder pane is displayed that has Flow (default view), List and Dual view. You can drag the
required actions from the left pane to create a task.

5. In Triggers > Hot key, drag Hot key trigger into Drag a trigger here in the bot logic.
6. Set Ctrl and L as the hot key combination.
7. Use the Search actions field to find Interactive forms.

© 2023 Automation Anywhere. All rights reserved.     2205



    Automation Anywhere - Crea

8. Drag Display into the task logic.
You can use the display action to show the form when the bot is triggered. The display action
properties appear on the right.

9.
Click the create variable icon ( ) to create a variable.
You have to create a form variable by linking an existing form. This enables you to use the form
variable and the associated form across multiple instances.

Nota:  The form variable can be linked only to forms created using the Control Room form builder.

10. On the Create variable screen, enter a name for the form variable you are creating.
11. Click Browse and select the New User Registration form.

This links the New User Registration form to the form variable that you are creating.
12. Click Create & select.

A new form variable is created. For any existing form variable, use the Form name drop-down menu
to select it.

13. Use the Search actions field to find Trigger loop and drag it to add event monitoring.
Event monitoring enables you to simultaneously set multiple events within the task logic of a bot.

14. Drag Handle into the Trigger loop.
Handle enables you to run an action by configuring a trigger in the Trigger loop: Handle for the bot.
You can set a trigger when a event occurs on the selected interface (selected application) or when a
user clicks the selected form element.

15. For this scenario, use the Trigger on drop-down menu to select INTERACTIVE FORMS > Form
trigger.

16. Click the Form name drop-down menu and select the New User Registration form.
This enables you to set a trigger for the Submit option of the New User Registration form.

17. Click the Form element drop-down menu and select Submit.
For the Button element of a form, the Select action trigger is set to Clicked by default. When the
user clicks Submit on the New User Registration form, it triggers the User Agreement form.

18. (Optional) Use Assigned to to create a variable.
You can use this variable to fetch various details for the element you have selected in the Form
element drop-down menu. This return value is either a string or number based on the element type
selected. For example, if you have selected the Date element, the return value is a string.

19. Search for Interactive forms and drag Display into Trigger loop: Handle.
20. Click the Form name drop-down menu and select User Agreement form.

The User Agreement form appears.
21. Search for Message and drag it into Trigger loop: Handle, after Interactive forms.

A successful registration message appears when the user clicks Submit.
22. Terminate the trigger by dragging Break into the Trigger loop.

Use Break to exit the current event loop and for actions where finishing a process is required.
23. Drag another Handle next to the Trigger loop: Handle.

This enables you to set a trigger for the Cancel option of the New User Registration form.
24. Click the Form element drop-down menu and select Cancel.
25. Search for Message and drag it into Trigger loop: Handle. Update the Enter the message to

display field as User registration is canceled.
When the user clicks Cancel on the New User Registration form, it triggers a User registration
is canceled message and terminates the bot.

26. Drag Trigger Loop > Break to terminate the loop.
27. Fai clic su Salva.
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28. Click Run with triggers.
The Run with triggers sets the Hot key trigger to start the bot, which is Ctrl plus L combination
from the keyboard in this scenario.

Riferimenti correlati
Interactive forms package alla pagina 1638
The interactive forms package contains actions that handle exceptions encountered by a bot. All the
actions performed by users on the interactive forms can be monitored to execute logic using subtasks.

Adding a trigger to run a bot
Add triggers that can automatically run the selected bot whenever a specific event occurs. For example,
clicking a specific button or using a combination of keystrokes.
Triggers integrate predefined events into your workflow and reduce the number of repetitive tasks that
users must perform. Attended automation in Automation 360 enables you to create unique triggers for
various applications. You can then use these triggers to start a bot.
Use one of the following types of triggers to start a bot:

Importante:  Trigger are not supported for private workspace, the trigger functionality will not work.

E-mail Starts a bot when a new email message is received
in the specified email service such as Microsoft
Outlook, Email server, or EWS server.

File e cartelle Starts a bot when a predefined file or folder event
occurs. You can set one of the following options as
the trigger:
• When a new file or folder is created.
• When an existing file or folder is deleted.
• When a file or folder is renamed.
• When a file or folder is modified.

Hot key Starts a bot when a predefined combination of
keystroke is performed on the keyboard. You can
set a combination of the following keys as the
trigger:
• Control keys such as Ctrl, Alt, Windows logo key,

 and Esc.
• Keys with regular alphabetical (English)

characters.

Interfaccia Starts a bot when a predefined event occurs on the
selected user interface element. Some examples of
the predefined events are:
• User clicks a button.
• User opens or closes an application.
• User selects or clears a checkbox.

Nota:  When capturing an interface trigger in a
SAP application, ensure that both the Recorder and
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Interface trigger packages are from Build 5933 or
from a prior release.

Processo Starts a bot when a predefined event occurs on
the selected Microsoft Windows process. Some
examples of the predefined events are:
• User starts a process.
• User stops or closes a process.

Servizio Starts a bot when a predefined event occurs on
the selected service in Microsoft Windows. Some
examples of the predefined events are:
• Service starts or stops.
• User pauses the service.
• User resumes the service that was paused\.

Finestra Starts a bot when a predefined event occurs on
the selected application window. An example for a
predefined event is when a user opens or closes an
application.

Riferimenti correlati
Trigger loop package alla pagina 1917
The Trigger loop package enables you to run a series of actions when a trigger event occurs. You can
insert multiple trigger loops within a bot or nest one trigger loop within another trigger loop.

Add an email trigger
Starts a bot when a new email message is received from the predefined email service.
Connect the Control Room to one of the email services on your system and trigger the bot when you
receive a new email.
For email automation, you can use OAuth 2.0 to authenticate with the email server. To register your
application with the Microsoft identity platform, see Using Connect action for Email alla pagina 1497
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Fai clic su Crea nuovo > Bot.
3. Inserisci un nome per il bot.

All the bots are stored under the \Bots folder. (Optional) Click Browse to change the folder.
4. Fai clic su Crea e modifica.
5. In the bot builder page, click Triggers > Email trigger.
6. Drag Email into Drag a trigger here.
7. Use the Email trigger pane on the right to choose one of the following server types as the trigger for

your incoming emails:
Tipo di server Fasi

Microsoft Outlook Click Outlook.
Microsoft Outlook is set as the email service and the bot is triggered when
you receive a new email.
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Tipo di server Fasi

Server e-mail Click Email server.
a. Enter the email service Host information.

For example, if you are using Office365 as your email service, enter
Outlook.office365.com.

b. Select IMAP or POP3.
IMAP and POP3 are protocols used to connect to the mail server that
enables you to read your emails through an email client.

Nota:  The POP3 protocol has a known limitation where any new
calender invite can also trigger the bot.

c. Usa connessione sicura (SSL/TLS): Select this option if you want
to use a secure connection with the mail server.

d. Enter the configured port number for your email server.
e. Select one of the following user authentication methods to sign in to

the email server:
• Basic

• Credenziale: Click Pick to select the stored Username and
Password.
Credentials and credential variables in the Bot editor alla pagina
2039

• Insecure string: Enter the username and password.

• Client credentials
• Specify the unique client and tenant IDs generated when you

registered the application in the Microsoft Azure portal.
• Specify the username you want to use to access the mail server.
• Specify the client secret that you generated for your app in the

app registration portal.
For Client ID, Tenant ID, Username and Client Secret
fields, choose from Credential or Insecure string tab:
• Credenziale: Use a value available in the credential vault.
• Insecure string: Manually enter a value.

Nota:  Client Credentials flow does not support Gmail.

Nota:  The Email in folder does not support sub-folders when you
set the protocol as POP3 for Email Server,
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Tipo di server Fasi

Server EWS Click EWS server.
a. From the Microsoft Exchange Version drop-down menu, select

your current version.
For example, if you are using Microsoft Exchange Service Pack 2,
select Exchange2010_SP2 as your email service.

b. Enter the domain name, for example, smtp.office365.com
c. Select one of the following user authentication methods to sign in to

the email server:
• Basic

• Credenziale: Click Pick to select the stored Username and
Password.
Credentials and credential variables in the Bot editor alla pagina
2039

• Insecure string: Enter the username and password.

• Client credentials
• Specify the unique client and tenant IDs generated when you

registered the application in the Microsoft Azure portal.
• Specify the username you want to use to access the mail server.
• Specify the client secret that you generated for your app in the

app registration portal.
For Client ID, Tenant ID, Username and Client Secret
fields, choose from Credential or Insecure string tab:
• Credential: Use a value available in the credential vault.
• Insecure string: Manually enter a value.

8. Opzionale: Use the Check every drop-down menu available under all the server types to set the
trigger interval.
The trigger interval for the bot is set to 120 seconds by default.

9. Opzionale: Use Select Conditions to specify an email event for the selected server type.
Consider a scenario where you select Outlook and want to trigger a bot when you receive an email
from a specific sender. In Select Conditions, select the Email from check box and specify the
sender's email address.
When you select the Email subject contains check box, the email trigger is executed depending on
the following subject conditions:
• Quando l'oggetto viene indicato tra virgolette doppie (""), ad esempio, "Foglio di calcolo

ABC", il trigger viene eseguito solo se l'oggetto dell'e-mail ha una corrispondenza esatta con la
stringa fornita tra virgolette.

• Quando più righe di oggetto sono separate da un punto e virgola, ad esempio, foglio di
calcolo ABC; registri del progetto ABC, il trigger viene eseguito quando l'oggetto
dell'e-mail corrisponde a una qualsiasi delle righe dell'oggetto menzionate.
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10. Opzionale: To create a variable, in the Assigned to > Record tab, click

.
You can use this variable to retrieve various details about the email that triggered the bot, such as
sender, recipient, subject, email content, date, action information, email server host, and port data.

11. Fai clic su Applica.
12. Fai clic su Esegui > Esegui con trigger.

Microsoft Outlook, Email server, or EWS server is set as the trigger to start the bot for new emails.

Nota:  When you run an email trigger, the emailTo key returns a list of To addresses. To convert the list
of To addresses into a string, use the Assign action from the List package and then use the Join items
action from the List package, with the comma as a delimiter to separate the addresses.

Add a file and folder trigger
Starts a bot when a predefined action such as create, delete, rename, or modify is performed on a file or a
folder.
This procedure is for a scenario where you want to trigger a bot when a user modifies a document called
Product info.docx.

Nota:  This scenario is for a user with Bot Creator role.
For information about how a user with a Bot Runner role can link event triggers, see Collegamento di trigger
di evento a un Bot Runner alla pagina 2627.

1. Nel pannello di sinistra, fai clic su Automazione.
Viene visualizzato un elenco dei moduli e dei  disponibili.

2. Fai clic su Crea nuovo > Bot.
3. Inserisci un nome per il bot.

All the bots are stored under the \Bots folder. (Optiona0 Click Browse to change the folder.
4. Fai clic su Crea e modifica.
5. In the bot builder page, click Triggers > Files & folders.
6. Drag File trigger into Drag a trigger here.
7. Click Browse and select the Product info.docx file.
8. From the Start the bot when the file is drop-down menu, select modified.

This sets the trigger for the bot.
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9. Opzionale: Utilizza il menu a discesa Assegnato a per assegnare una variabile.
Se desideri utilizzare la scheda Variabili per creare una variabile, assicurati di selezionare la casella di
controllo Usa come input per visualizzarla nel menu a discesa Assegnato a (facoltativo).

Nota:  If you use the  in the Assigned to (optional) drop-down menu to create a variable,
ensure that you do not select the Constant (read only) check box.

The following set of data can be retrieved by defining a variable as the input type, which you can
assign to get output from the trigger:
• triggerType: File or folder trigger
• eventType: The type of trigger event

The following set of data cannot be used if the Set Schema check box is selected as it returns a non-
string variable type:
• timeStamp: The time when the trigger occurred

Ensure you link the timeStamp value to a string variable to obtain the trigger data. For example,
consider you want to extract the date and time for the trigger event when a user modifies the
Sales update.xls file. Use the Message action within the task logic, and enter Date Time-
 $recordVar[2]$ in the Enter the message to display field.

• fromFolder: Details of the parent folder path
• folder: Details of the file or folder path on which the event occurred

10. Fai clic su Salva.
11. Fai clic su Esegui > Esegui con trigger.

Whenever a user modifies the Product info.docx, the bot is triggered.

Riferimenti correlati
Trigger di evento alla pagina 2624
Un trigger di evento è un'azione predefinita che esegue un bot associato. Tutti i bots con trigger di evento
sono elencati nella scheda Trigger di evento.

Add a hot key trigger
Starts a bot when a predefined combination of keys is used on the keyboard.
This procedure is for a scenario where the bot is triggered when a user presses Ctrl (plus) L keys from the
keyboard.

Nota:  Hot key triggers are supported on both attended and unattended Bot Runner licenses. However,
the hot key trigger will work for unattended Bot Runner users only if they have access to the associated
default device and they use the predefined keys.

1. Nel pannello di sinistra, fai clic su Automazione.
Viene visualizzato un elenco dei moduli e dei  disponibili.

2. Fai clic su Crea nuovo > Bot.
3. Inserisci un nome per il bot.

All the bots are stored under the \Bots folder. (Optional) Click Browse to change the folder.
4. Fai clic su Crea e modifica.
5. In the bot builder page, click Triggers > Hot key.
6. Drag Hot key trigger into Drag a trigger here.
7. Click Ctrl to set it as the Hot key from the available key modifiers.
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8. Use the drop-down menu to select L from the keyboard.
The Hot key field displays the key combination that will trigger the bot.

9. Fai clic su Applica.
10. Fai clic su Esegui > Esegui con trigger.

When the Ctrl and L keys are used on the keyboard, the bot is triggered.

Add an interface trigger
Starts a bot when a predefined action occurs on a specific interface element, such as clicking a button or
closing an application.
The following procedure is for a scenario where you want to configure a trigger to start a bot when the
user clicks New option in Microsoft Word. Before you configure the trigger, ensure that you have the
Microsoft Word application open on your system.

Nota:  Interface triggers for objects are available only for native Windows applications.

Nota:  Interface triggers are supported on both attended and unattended Bot Runner licenses. However,
the interface trigger will work for unattended Bot Runner users only if they have access to the associated
default device and perform the predefined action on the specified interface element.

1. Nel pannello di sinistra, fai clic su Automazione.
Viene visualizzato un elenco dei moduli e dei  disponibili.

2. Fai clic su Crea nuovo > Bot.
3. Inserisci un nome per il bot.

Tutti i bots sono memorizzati nella cartella \Bots. (Optional) Click Browse to change the folder.
4. Fai clic su Crea e modifica.
5. In the bot builder page, click Triggers > Interface trigger.
6. Drag Object into Drag a trigger here.

The Interface trigger: Object editing panel appears.
7. In Window detail tab, click Application.

Nota:  For browser-based events, click Browser and select the correct browser tab. Interface
triggers are supported on only Google Chrome and Edge Chromium browsers.

8. Click the drop-down menu and select Taskbar under Preset.
If Microsoft Word is not displayed in the list, you can use the Refresh option to reload the list of
applications.

9. Fai clic su Acquisisci oggetto.
This initiates a built-in web recorder that captures the action. In this scenario, Microsoft Word is
displayed. Click New, which is then set as the trigger to start the bot.

10. Click the Select main event drop-down menu to choose a specific event.
In this scenario, New in Microsoft Word is considered a button and the following events are available:
• Fai clic: Triggers the bot when the user clicks the selected main event object.
• Click with hotkey: Use one of the available key modifiers and select a key (alphabetical letters)

from the drop-down menu. This combination is set as the hot key to trigger the bot.

11. Facoltativo: Select one of the available Control keys (Shift, Alt, Ctrl, Windows and AltGr) as an
additional combination for the hot key to trigger the bot.

12. Fai clic su Salva.
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13. Fai clic su Esegui > Esegui con trigger.
The preset trigger is created, and the bot is triggered when the user clicks New in Microsoft Word.

Aggiunta di un trigger di processo
Avvia un bot quando si verifica un'azione predefinita sul processo Microsoft Windows selezionato.
Questa procedura è per uno scenario in cui desideri configurare un trigger per avviare un bot quando
l'utente avvia o chiude Microsoft Outlook. Prima di configurare il trigger di processo, assicurati di avere
l'applicazione Microsoft Outlook aperta sul tuo sistema in modo da poter selezionare questo processo.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Fai clic su Crea nuovo > Bot.
3. Inserisci un nome per il bot.

Tutti i bots sono memorizzati nella cartella \Bots. (Optional) Click Browse to change the folder.
4. Fai clic su Crea e modifica.
5. In the bot builder page, click Triggers > Process trigger.
6. Trascina Processo in Trascina un trigger qui.

Viene visualizzato il pannello di modifica Trigger di processo: Processo.
7. Click the Process name drop-down menu and select Outlook.exe.

Aggiorna il menu a discesa Nome processo se nessuno dei processi è elencato.
8. Select the following check boxes to set the trigger condition:

• Avvia: Attiva il bot quando gli utenti aprono o avviano Microsoft Outlook.
• Sospendi: Attiva il bot quando gli utenti chiudono o arrestano Microsoft Outlook.

9. Opzionale: Utilizza il menu a discesa Assegnato a per assegnare una variabile.
If you want to use the Variables tab to create a variable, ensure that you select the Use as input
check box for it to appear in the Assigned to (optional) drop-down menu.

10. Fai clic su Salva.
11. Fai clic su Esegui > Esegui con trigger.

Il trigger preimpostato viene creato e il bot viene attivato quando l'utente avvia o chiude l'applicazione
Microsoft Outlook.

Aggiunta di un trigger di servizio
Avvia un bot quando una qualsiasi delle azioni predefinite si verifica sul servizio selezionato in Microsoft
Windows.
Questa procedura è per uno scenario in cui si vuole configurare un trigger per avviare un bot quando il
servizio Windows Update viene avviato, arrestato o messo in pausa da un utente.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Fai clic su Crea nuovo > Bot.
3. Inserisci un nome per il bot.

Tutti i bots sono memorizzati nella cartella \Bots. (Optional) Click Browse to change the folder.
4. Fai clic su Crea e modifica.
5. In the bot builder page, click Triggers > Service trigger.
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6. Trascina Servizio in Trascina un trigger qui.
Viene visualizzato il pannello di modifica Trigger di servizio: Servizio.

7. Fai clic sul menu a discesa e seleziona Windows Update.
Aggiorna il menu a discesa se nessuno dei servizi è elencato.

8. Seleziona le seguenti caselle di controllo per impostare la condizione di attivazione per il servizio
Windows Update:
• Avvia
• Sospendi
• Metti in pausa

9. Opzionale: Utilizza il menu a discesa Assegnato a per assegnare una variabile.
Se desideri utilizzare la scheda Variabili per creare una variabile, assicurati di selezionare la casella di
controllo Usa come input per visualizzarla nel menu a discesa Assegnato a (facoltativo).

10. Fai clic su Salva.
11. Fai clic su Esegui > Esegui con trigger.

Il trigger preimpostato viene creato e il bot viene attivato quando un qualsiasi utente avvia, arresta o
mette in pausa il servizio Windows Update.

Aggiunta di un trigger di finestra
Avvia un bot quando la finestra dell'applicazione predefinita viene aperta o chiusa dall'utente.
Questa procedura è per uno scenario in cui si vuole configurare un trigger per avviare un bot quando
un qualsiasi utente apre un documento Microsoft Excel chiamato Customer_database.xls. Prima di
configurare questo trigger di finestra, assicurati di aver aperto il documento Database_cliente.xls sul tuo
sistema in modo da poter selezionare questa finestra.
1. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
2. Fai clic su Crea nuovo > Bot.
3. Inserisci un nome per il bot.

Tutti i bots sono memorizzati nella cartella \Bots. (Optional) Click Browse to change the folder.
4. Fai clic su Crea e modifica.
5. In the bot builder page, click Triggers > Window trigger.
6. Trascina Finestra in Trascina un trigger qui.

Viene visualizzato il pannello di modifica Trigger di finestra: Finestra.
7. Fai clic sul menu a discesa Finestra e seleziona Database_cliente.xls.

Aggiorna il menu a discesa Finestra se nessuna delle finestre disponibili è elencata.
8. Sotto il campo Titolo della finestra, fai clic sulla scheda Stringa per impostare l'intero titolo della

finestra selezionata.
Per selezionare un modello corrispondente al titolo della finestra selezionata è possibile utilizzare la
scheda Regex. Ad esempio, se si seleziona l'opzione Regex in questo scenario, il bot viene attivato
se l'utente apre un qualsiasi file .xls.

9. Seleziona Apri dal menu a discesa Azione Finestra che avvia il bot.
10. Opzionale: Utilizza il menu a discesa Assegnato a per assegnare una variabile.

Se desideri utilizzare la scheda Variabili per creare una variabile, assicurati di selezionare la casella di
controllo Usa come input per visualizzarla nel menu a discesa Assegnato a (facoltativo).

11. Fai clic su Salva.
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12. Fai clic su Esegui > Esegui con trigger.
Il trigger preimpostato viene creato e il bot viene attivato quando un qualsiasi utente apre il
documento Database_cliente.xls.

ServiceNow New Record trigger
Create a trigger to monitor a ServiceNow table for new records and begin succeeding RPA actions in your
bot flow.
• The bot creator must have access to a ServiceNow account with required permissions to perform tasks

enabled by this package. See Roles.
• Follow ServiceNow guidelines for authenticating to an external client with OAuth 2.0. See Set up OAuth.
• Create a Developer account and Developer instance in ServiceNow. See Personal Developer Instances.
• Ensure that you are authenticated before initiating any ServiceNow action. Vedi Autenticazione alla

pagina 1846

The new record trigger monitors the creation event of any record within a time period. Upon record
creation, the trigger invokes and returns data. If multiple records are created within the entered time
period, then the trigger returns data of multiple records.
Map your trigger to a ServiceNow table, and then enter the time period to send a query for that table data.
When a new record is found, this trigger is invoked and begins succeeding bot actions.
1. Enter the URL for your ServiceNow instance.
2. (Optional) Enter the API version.
3. Select how ServiceNow credentials will be entered for the following fields.

Opzione Descrizione

Credenziale Select a credential saved in a secure locker that
you have mapped to your Control Room.

Stringa non sicura Enter the credential.

a) Enter the Client ID.
b) Enter the Client secret.
c) Immetti il nome utente.
d) Enter the Password.

4. Enter the Table name in ServiceNow to monitor for new records.
A query is sent, and ServiceNow returns data for this table. When a new record is returned in the
data, then this trigger is invoked.

5. (Optional) To store a response from ServiceNow, select and enter a List or Variable input where the
response is stored.

6. (Optional) Apply filters to specify the type of ServiceNow record to monitor.
7. Enter how frequent the trigger searches for new records in the Check every (seconds) field.
8. (Optional) Select a variable to save returned data by the trigger.

ServiceNow Updated Record trigger
Create a trigger that monitors a ServiceNow table for updated records and begins succeeding RPA actions
in your bot flow.
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• The bot creator must have access to a ServiceNow account with required permissions to perform tasks
enabled by this package. See Roles.

• Follow ServiceNow guidelines for authenticating to external client with OAuth 2.0. See Setup OAuth.
• Create a Developer account and Developer instance in ServiceNow. See Personal Developer Instances.
• Ensure that you are authenticated before initiating any ServiceNow action. Vedi Autenticazione alla

pagina 1846

The updated record trigger monitors the record within a time period. When updates occur, the trigger
invokes and returns data. If multiple records are updated within the entered period, then data of multiple
records is returned.
Map your trigger to a ServiceNow table. Enter the time period to send a query for that table data. When an
updated record is found, this trigger is invoked and can begin succeeding bot actions.
1. Enter the URL for your ServiceNow instance.
2. Enter the API version.
3. Select how ServiceNow credentials will be entered for the following fields.

Opzione Descrizione

Credenziale Select a credential saved in a secure locker that
you have mapped to your Control Room.

Stringa non sicura Simply enter the credential. This data will remain
visible.

a) Enter the Client ID.
b) Enter the Client secret.
c) Immetti il nome utente.
d) Enter the Password.

4. Enter the Table name where the record is located in ServiceNow.
This data is what the trigger monitors. A query is sent, and ServiceNow returns data for this table.
When a record update is returned in the data, then this trigger is invoked.

5. (Optional) To store a response from ServiceNow, select and enter a List or Variable input where the
response is stored.

6. (Optional) Apply filters to specify the type of ServiceNow record to monitor.
7. Enter how frequent the trigger searches for updated records in the Check every (seconds) field.
8. (Optional) Select a variable where returned data is saved by the trigger.

Example for using hot key to trigger a bot
In this example, a front desk executive of an insurance company responds to a call from an existing
customer who wants to understand the policy details and its validity. The executive uses a hot key to
trigger a bot that retrieves the customer's information.

Information about all the existing customers and the insurance company's various policies is distributed
across two different databases. An existing bot maps the data between the two databases and provides
consolidated information in a user readable format to the executive. Ctrl+L is set as the hot key to trigger
this bot.
1. The executive collects caller's information to verify if it is an existing customer.

The executive confirms the caller is an existing customer who wants to know the policy details.
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2. The executive uses Ctrl+L to trigger a bot.
The bot retrieves the customer information and the corresponding policy details. An authorization
message is displayed.

3. The executive reviews the information that is consolidated in a form, and answers the customer
queries without any delay or hold time.
The following image illustrates this attended automation scenario:

Embedded Automation
Access automated processes and bots from any platform with an embedded interface. Embedded
Automation delivers automation everywhere you want, either integrated with your web application or
delivered through a browser extension.

Perché usare Embedded Automation

Embedded Automation brings the power of AARI directly to any cloud environment or web application
packaged in an intuitive widget interface. The capability of Embedded Automation empowers end users
with essential access to data across platforms, delivered directly to their core interactive space. This data
access could be forms, applications, business history, and more. Whenever users need data, Embedded
Automation ensures that it is readily available.
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With automations a click away, there's little need to keep open an additional application in your workspace.
Automations can simply be embedded in the familiar space you spend the majority of time. With accessible
automations, users are able to quickly reach out, deliver data, keep a customer interaction engaging and
progressive, and reduce time spent waiting.

Cosa si può fare con Embedded Automation

There are many cases where users can leverage this ever-present access to launch automations and
processes in their familiar environment. The following are a few cases where Embedded Automation
improves workflow with streamlining and precision:

Fetch case data from user input or from
hosting data input

Access, complete, and submit forms with business
data onscreen in your web application. This further
empowers running attended bots that rely on
source context and visual cues while executing.

Launch automation with hosting data input While updating an account, business users can
run a bot that takes a sales order number, fetches
additional details as needed, and then pushes all
details into the system to immediately begin billing
for the sale.
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Orchestrate case resolution and business
workflow

Automated processes can guide agents through
a complex task involving management approval,
prompting and alerting team members during
process phases to expedite approval, and finally
enter customer and business data into a final
document rendered for official record.

Automate mundane local tasks Bots can upload sales leads or contact info from a
desktop spreadsheet to web applications with one
easy click.

Componenti di Embedded Automation

The two main components in Embedded Automation are as follows:

A widget within web application through
AARI Integrations

AARI Integrations embeds in web applications as
a widget. If you are an end user you can access
automated processes and bots without leaving your
environment. The widget is composed from an
HTML inline frame or simply an iFrame widget that
the user can configure and access in supported web
browsers.

An extension on Google Chrome browser
through AARI Extensions

AARI Extensions embeds in web applications as
a side panel rendered by an extension for Google
Chrome browser. As an end user, you can access
automated processes and bots without leaving
your environment. In addition, AARI Extensions
offers further adaptability through web page
customization, such as mapping an automation
to web elements, for example, a button. With
an OAuth 2.0 connection, existing access to
automations in the Control Room are now shared
with AARI Extensions to offer you a seamless user
experience.

The AARI admin has the key role of organizing access points for business users using Embedded
Automation.
For AARI Integrations, the iFrame widget embeds seamlessly into adjacent content of your web
application. The AARI admin must first set up and configure the iFrame widget details using AARI and then
assign automations to teams by adding specific members of a team and defining the team owners and
admins. After setup is completed business users can deploy automations in their web application using the
iFrame widget.
AARI Extensions has a similar setup process, differing in the way the widget is accessed, via an extension
for Google Chrome browser. Because of this difference, a developer has to enable web components for the
extension. Similar to AARI Integrations, the admin completes the setup and configuration of the iFrame
widget using AARI. Next, a bot creator develops a web component using a Page Editor, assisted by the
iFrame widget embed code, supplied in AARI. Newly created web components become visible within AARI
for Administrators to assign to teams. Assigned users will then navigate to their web application and access
the iFrame widget, while logged in to their Control Room.
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References

Learn more about the usages of AARI Integrations and AARI Extensions in AARI Integrations e AARI
Extensions alla pagina 2221.
Learn more about Automation Anywhere Robotic Interface (AARI) and its functions in Automation Anywhere
Robotic Interface (AARI) alla pagina 2106.

AARI Integrations e AARI Extensions
Compare the two delivery methods of Embedded Automation to decide on the right component for your
business needs.
AARI is a platform for automation to assist business users with common workflows. Users can continue to
automate using AARI in their favorite web applications and CRM platforms, such as the ServiceNow service
portal. When you use AARI Integrations to set up your iFrame widget, you can now access AARI through
an embedded widget in your web application and deploy automations, all without the need to leave your
environment.

Comparing Embedded Automation components

As you explore AARI Integrations and AARI Extensions, they might seem very similar. They are both
solutions that provide your environment with an iFrame widget interface powered by AARI. The iFrame
widget hosts automations from AARI on the web, offering the same power of automating with Automation
360.
Either AARI Integrations or AARI Extensions can deliver Embedded Automation. However, depending on
where you aim to embed, one component might better suit your needs over the other.
Simply put, the decision to embed a widget in your environment relies on choosing one of the following.
• Integration: Add an iFrame to the source code of your web application.
• Extension: Develop custom bricks that are coded into your browser through an extension.

Consider technical specifications and styles of these components.

AARI Integrations

AARI Integrations embeds in web applications as an iFrame widget offering end-users access to automated
processes and bots without leaving their environment.
Consider the following prerequisites for using AARI Integrations:
• Automation 360 v.26 or later.
• Google Chrome, Microsoft Edge Chromium, or Apple Safari web browsers. Consulta Requisiti del browser

per RPA Workspace alla pagina 866.
• AARI licenses and fluency.
• AARI web interface.
• Web application that supports the iFrame widget.

For further details on how to start using AARI Integrations, click the image to navigate to the overview
topic:
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AARI Extensions

AARI Extensions relies on a Chrome extension of your web browser to embed automations. The widget
appears outside the application as an Automation Anywhere stylized panel, as in the following image.
Consider the following prerequisites for using AARI Extensions:
• Automation 360 v.26 or later.
• Google Chrome web browser.
• AARI licenses and fluency.
• OAuth 2.0 Control Room configuration for server validation.

For further details on how to start using AARI Extensions, click the image to navigate to the overview
topic:
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Panoramica di AARI Integrations
You can use a widget that embeds automations built on the Automation 360 platform that can be applied
natively on any supported web application.

Capabilities

iFrame widget A widget that is composed from an HTML inline
frame, or simply iFrame widget, can be used as
a "window" to access another website located
in your current web application environment. In
addition, the iFrame widget provides reliable and
secure methods of quick integrations performance
without the need for heavy development work,
when involved with custom integrations.
For example, your current web application
environment is domain 1, which can access a
widget that shows a website from domain 2. These
two domains exist in one shared environment,
without you navigating to a separate page or
window.
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iFrame widget experience on supported web
applications

The Automation 360 platform can support
embedding an iFrame widget on any web
application that supports the iFrame technology
to access external contents. Many software-as-
a-service (SaaS) web applications support the
iFrame widget to allow for customization in a secure
environment.
Business users can add contextual workflow
automations from inside their most used and
preferred enterprise applications. This approach
means that users need to add only minimal code
to their most used web applications, which when
applied can produce a rich, friendly, and more
secure interactive user experience.

Actions that can be performed with iFrame
widget

Business users can use iFrame widget to perform
the following:
• Invoke local automations on their desktop.
• Invoke multistep process workflows from AARI

requests.
• Monitor request progress to completion.
• Receive notification of pending tasks.
• Respond directly to pending tasks from iFrame

widget.
• View the history of currently running or

previously completed automations.

Requisites

• Ensure that you have the proper role and permissions. Creazione di utenti per Automation Anywhere
Robotic Interface alla pagina 2116
• AARI license.
• Proper roles for AARI admin and user.

• Automation 360 v.26 or later.
• Google Chrome, Microsoft Edge Chromium, or Apple Safari web browsers. Consulta Requisiti del browser

per RPA Workspace alla pagina 866.
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• AARI web interface.
• Web application that supports iFrame technology.

Flusso di processo

1. Set up your integrations and iFrame widget for a web application.
2. Assign automations to a team for them to access data from the iFrame widget.
3. Configure widget settings in a web application to properly access iFrame widget.
4. Deploy the iFrame widget.

Workflow map: Click the following schematic image to view the AARI Integrations workflow in an

interactive visual format:
1. AARI Integrations

Setup iFrame widget using AARI Integrations
You can define your integrations with iFrame widget for your supported web applications. This includes
creating a new integration, iFrame widget, and configuring the iFrame widget code.
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Assicurati di aver completato i seguenti passaggi:
• Fornito un ruolo Amministratore AAE_Robotic_Interface creato dal sistema per l'amministratore

AARI.
• Have access to the AARI web interface.
• Complete any necessary password changes to access the AARI web interface.

For this task, you can create new integrations and configure your iFrame widget details including access to
the embed code for you to copy and use in a web application.

Importante:  You can only setup integrations and iFrame widget details for web applications that
supports the iFrame widget. If the web application does not support the iFrame widget, refer to AARI
Integrations e AARI Extensions alla pagina 2221.

1. Log in to the AARI web interface.
2. Navigate to Manage > Integrations.

The Integrations Setup page appears for you to setup your connection. If this is your first time
accessing this page, you will see the No Integrations label.

3. Click Add Integrations to add a new integration.
4. Specify a name for the integration in the Name field.

You can name it Integrations or the name of your favorite web application to help you define the
web application that you plan to embed the iFrame widget.

5. Facoltativo:Specify a description for your integration in the Description field.
6. Fai clic su Crea e modifica.

Your integrations is now created and forwards you to an Edit integration page that you can edit
your integration.

7. Navigate to the Widgets tab in the same page.
You can add iFrame widgets to your integration in this tab.

8. Fai clic sull'icona col segno più (+).
The Add Widget page prompts you to add a new iFrame widget to your integration.

9. Specify a name for the iFrame widget in the Widget name field.
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10. Specify your tags in the Filtered automations field.
You can select existing tags from the drop-down to add to the widget. When you add tags, they
display in the widget tab in the tags column next to the widgets.

11. Fai clic su Salva.
You have now successfully defined a new iFrame widget for your integration.
You can now generate an iFrame code.

12. Click the three dots (ellipses) next to the name of your iFrame widget.
• Embed code option allows you to generate code for the iFrame widget.
• Edit option enables you to edit the iFrame widget details.
• Delete option will delete the iFrame widget.

13. Click Embed code option.
The Embed code window appears and prompts you configure the code details.

14. Specify the size of the iFrame widget width and height in the Widget width and Widget height
fields, respectively.

Nota:  The default size of the iFrame widget width and height are 100 %. You can change %
(default) to px for pixels depending on your preference.
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15. Click Copy in the Embed code section to copy the code.

16. Facoltativo:Click Email embed code if you would like to open your local mail client to email the
embed code to another individual.
You now have access to the iFrame widget code.

17. Fai clic su Chiudi.
You have now successfully copied your iFrame widget code that can be used in a supported web
application.
For your next steps, you can assign automations to your team, see Assign automations to teams alla
pagina 2228.

Assign automations to teams
You can configure teams to access automations and tasks for it to be accessed via the Desktop Assistant,
AARI web interface, and the iFrame widget embedded in other business applications.
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Assicurati di aver completato i seguenti passaggi:
• Fornito un ruolo Amministratore AAE_Robotic_Interface creato dal sistema per l'amministratore

AARI.
• Have access to the AARI web interface.

1. Log in to the AARI web interface.
2. Assign members to a team alla pagina 2229.
3. Assign teams to a process alla pagina 2230.
4. Assign teams to a bot alla pagina 2230.

Your have now assigned automations for your team. Members of your team can now automate using
the iFrame widget.
For your next steps, you can configure the widget in a web application to access to automations in the
iFrame widget, see Configure iFrame widget in a web application alla pagina 2231.

Assign members to a team
You can follow this task to create a new team and assign members to your team.

1. Navigate to Manage > Teams.
The Team Setup page appears for you to create new or edit existing teams.

2. Fai clic su Crea nuovo team.
The Create a team window appears with details for you to edit.

3. Specify the name of the team in the Team Name field.
4. Specify a description for your integration in the Description field.
5. Select the AARI Manager option in the Team admin field.

The AARI manager will be the team admin that manages the user and their access.
6. Fai clic su Crea e modifica.

You will now be forwarded to the Edit team page where you can edit the team attributes.
7. Select the Shared or Private option in the Request Visiblity section.

• Shared option allows for all requests to be access by all member, owners, and team admins in the
team.

• Private option allows for the requests to be to be available to only the member who created the
request, owner, and team admin in the team.

8. Navigate to the Users tab.
9. Click the plus (+) icon to add a users to your team.
10. Select a user or users to be added.
11. Click Add & save.

You have now added one or more users to your team.
12. Fai clic su Chiudi.

You have successfully added users to your team. You can now add automations to the team that
allows for members of your team to view and run the automations you assigned.

Attività correlate
Creare un team AARI e assegnare i ruoli ai membri alla pagina 2164
Un gestore AARI è un amministratore d team che può creare nuovi team, aggiungere membri al proprio
team e assegnare nuovi ruoli. L'amministratore AARI può anche configurare un team ma non ha un ruolo
nel team.
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Assign teams to a process
You can follow this task to assign teams to a process.

1. Navigate to Manage > Processes.
The Process Setup page appears for you manage your process.

2. Select your existing process from the list of available processes.
For example, you select the Ordered Items process.
The Edit process page appears with details of your process.

3. Navigate to the Teams tab.
4. Click the plus (+) icon to assign the teams to your process.
5. Select your team or teams.
6. Click Add & save.
7. You can repeat these steps and add teams to another process of your choice.
8. Fai clic su Chiudi.

You have successfully added teams your process.
You can now assign teams to your bot.

Attività correlate
Assegnare un team AARI a un processo alla pagina 2166
Un amministratore AARI può configurare processi nell'interfaccia Web e assegnare i team a un processo
per la creazione di una richiesta. Essi accedono all'interfaccia Web per visualizzare e gestire i processi nella
pagina Configurazione del processo.

Assign teams to a bot
You can follow this task to assign teams to a process.

1. Navigate to Manage > Bots.
The Bot Setup page appears for you manage your bots.

2. Click Add bot.
The Add bot page appears for you to add available bots.

3. Select a bot or bots.
For example, you select the Enterprise Account bot.

4. Click Add to add bot.
The bot that you selected will now be added to the bot list.

5. Select the bot that was added.
The Edit bot page appears with details of your bot.

6. Navigate to the Teams tab.
7. Click the plus (+) icon to assign the teams to your bot.
8. Select the team that you have created.
9. Click Add & save.
10. Fai clic su Chiudi.

You have now successfully added teams your bot.
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Configure iFrame widget in a web application
You must configure iFrame widget settings in a supported web application to properly enable the iFrame
widget.
Assicurati di aver completato i seguenti passaggi:
• Fornire un ruolo Utente AAE_Robotic_Interface creato dal sistema per l'utente AARI.
• Have access to the AARI web interface.
• Have access to the web application of your choice that supports the iFrame technology. For this task, it

would be the ServiceNow Service Portal and ServiceNow App Engine Studio.

1. Log in to the ServiceNow Service Portal.
2. Navigate to the Widget Editor page.

This page has a few options for you to configure your widget, as well as a reference for you to view
any recently updated widgets.

3. Click the Create a new widget option for creating new widgets.
The Add a Widget window appears with details for you to specify your widget.

4. Specify the name of the widget in the Widget Name field.
The ID of the widget will be automatically generated when you enter the name.
For example, you can name your widget AA Bots for reference that this is an Automation Anywhere
bots widget.

5. Fai clic su Invia.
A new window with an HTML template or editor prompts you to enter the iFrame widget details, if
applicable.

6. Paste your iFrame widget code to the HTML template.
This is the iFrame widget code that you had generated in the AARI web interface.

7. Click Save or press Ctrl + S to save the current session.
You have now added the iFrame widget code and saved your session. This is the code to embed your
iFrame widget.

8. Access to the main page of the ServiceNow App Engine Studio.
9. Navigate to All > Service Portal Configuration
10. Click Designer.
11. Select an existing page to edit.

You are now directed to a designer page.
12. Opzionale: Rearrange or remove your existing widgets on the page, to give space for the iFrame

widget.
13. Drag the widget you had created (ex: AA Bots) from the Widgets tab and place it on the page.

You have now successfully added the iFrame widget and should now be visible on the page.

Importante:  The iFrame widget is visible but with no styling applied.
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14. Navigate back to the ServiceNow Service Portal
15. Click Widget Editor.
16. Click on your widget (ex: AA Bots) from the Recently Updated list.

You are now navigated to the window with an HTML template. The page should also include a CSS
template.

17. Specify the widget (ex: AA Bots) details in the CSS template.
This can be the border size, style, and color of the widget.

18. Navigate back to the designer page.
The iFrame widget structure has now been updated.
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19. Aggiorna la pagina.
You will notice a small-sized window that appears and is connected to the AARI web interface with a
login page.

20. Log in with your user credentials to the iFrame widget in order to access your AARI data.
The iFrame widget will refresh and a list of automations and tasks from AARI is now available. You can
interact directly with your data.
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21. View the iFrame widget.

You have now successfully embedded the iFrame widget with AARI data to your web application.
For your next steps, you can deploy your automations using the iFrame widget, see Deploy automations
in web application alla pagina 2234.

Deploy automations in web application
You can now automate your tasks using the iFrame widget.
Assicurati di aver completato i seguenti passaggi:
• Fornire un ruolo Utente AAE_Robotic_Interface creato dal sistema per l'utente AARI.
• Have access to the AARI web interface.
• Have access to the web application of your choice that supports the iFrame technology. For this task, it

would be the ServiceNow Service Portal.

1. Log in to the ServiceNow Service Portal.
2. Navigate to the page(s) on which you had embedded the iFrame widget.

This can be the Designer portal in the ServiceNow Service Portal where you manage your data and
relevant information.
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3. Log in with your user credentials to the iFrame widget in order to access your AARI automations.
This is the user that is a assigned to a team.
The iFrame widget will refresh with a list of available automations.

4. Facoltativo:Fill your initial forms using URL parameters.
You can modify your URL with specific query parameters, to provide more control over your specific
data.

Nota:  Embedded Automation supports these parameters: Check Box, Date, Dropdown, Number,
Radio Button, Time, Text Area, and Text Box. For more details, see Parametri URL alla pagina 2153.
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5. Run your automations or complete pending tasks.
You can deploy automations using the iFrame widget in the ServiceNow Service Portal.

Nota:  You can run your bots with the Picture-in-Picture feature. You can enable this feature when
you configured your bot in AARI to run in a virtual window. Consulta Configure an AARI bot alla pagina
2174.
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Riferimenti correlati
Parametri URL alla pagina 2153
Questo argomento ti aiuta consente di fare riferimento ai parametri URL per gli elementi supportati.

Smart embedded forms and dynamic data mapping
As a developer, you can design smart forms to embed in a widget of a host web application where you can
run a script to populate data dynamically.
This enhanced form builder experience enables you to quickly design smart forms with more concise
controls. The smart forms are embedded as a widget (using iFrame widgets) in a web application where
you can populate data dynamically and run your automations.

See the following video for an overview of smart forms and dynamic data mapping:
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What a developer can do

Design smart forms with the enhanced form
builder:

• Drag form elements directly to the form builder
to add new elements.

• Resize individual form elements to a precise
length.

• Design forms to use in an embedded widget.

Populate data dynamically in an embedded
widget:

• Utilize a Javascript for a host web application to
read and use as inputs in AARI processes.

• Run a script (postMessage API JavaScript) to
populate the data of the AARI process based on
the process ID, element ID, and its value.

Vantaggi

Smart embedded forms provides the
following benefits:

• Dragging and resizing form elements are a
seamless and consistent experience.

• Developers can quickly add new elements to
their forms.

• Forms created in the form builder is rendered
the same way in an embedded widget.

• Form builder supports up to 25 form elements.
• Behaviors of the older forms are maintained.

Dynamic data mapping provides the following
benefits:

• Data is populated dynamically to avoid repetitive
data re-entry.

• Only specified data are dynamically populated,
which provides a secure way to run automations.

Concetti correlati
Embedded Automation alla pagina 2218
Access automated processes and bots from any platform with an embedded interface. Embedded
Automation delivers automation everywhere you want, either integrated with your web application or
delivered through a browser extension.
Panoramica di AARI Integrations alla pagina 2223
You can use a widget that embeds automations built on the Automation 360 platform that can be applied
natively on any supported web application.

Map host data to process
You can configure your widget settings from a host application and populate data in the initial form of
your iFrame widget. This ensures that you have control over your data without the need for repetitive data
entry.
Assicurati di aver completato i seguenti passaggi:
• Fornire un ruolo Utente AAE_Robotic_Interface creato dal sistema per l'utente AARI.
• Have access to the AARI web interface.
• Have access to the host web application of your choice that supports the iFrame technology.
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• You already set up the iFrame widget. For more details, see Configure iFrame widget in a web application
alla pagina 2231.

1. Log in to the host web application.
This is your target application with the iFrame widget.

2. Navigate to widget settings page or source code of your host web application (where you added the
iFrame widget code).
This page contains the embedded code for your widget source.

3. Enter the host data and send data in the script.

Importante:  To map data, you must load a process on the host web application with a process ID,
element ID, and values of the element ID which correlate with each another.

Example structure of host data:

hostData =
{
 process ID
    {
       elementID1: value1
       elementID2: value2
       elementID3: value3
   }
} 
sendDataToEmbeddedApp = (processID) =>
{
    iframeElement = document.querySelector();
    iframeElement.contentWindow.postMessage({data: hostData[processID]}, 
        iframeElement.getAttribute());
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}

Nota:  The element ID uses form element data types, such as: Check Box, Number, Radio Button, and
Text Box.

An additional sample structure:

In this example: 45 is the process ID, Number0 is the element ID, and 45 is the value of the element
ID.

4. Click Save or press Ctrl + S to save your session.
You have now configured the host data, and mapped the data to your processes.
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5. Accedi a iFrame widget.
The iFrame widget should show a list of automations.
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6. Click a process to open an intial form with data already mapped and filled in.

The initial form shows the mapped data.
7. Click Submit to run your automations.

Panoramica di AARI Extensions
Access automations in any web scenario with AARI Extensions, offering a custom widget through Google
Chrome extensions.

Importante:  The OAuth 2 configuration is required, and availability of this feature is based on your
region.
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Benefits and capabilities of AARI Extensions

Broader access to automations brought to
your familiar environment

With AARI Extensions, you can develop custom
actions and workflows. The OAuth 2.0 connection
offers a seamless connection from the Automation
Anywhere Control Room to your web browser.
This connection extends automated features into
your preferred environment through embedded
web components. Develop these components
in any web scenario through the use of AARI
Extensions. Users with these components can
launch automated processes and bots directly from
existing environments, where most time is spent.
With this access, business data can be retrieved
and processed without ever changing applications.

Secure connection with admin control for
organizing team and user workloads

AARI Extensions is fully integrated with Automation
Anywhere for security and authorization of
content. This means that the administrator has
complete control over which content is made
public through AARI by assigning AARI Extensions
content to teams. Content assigned to a team will
become visible to the members of the team when
the target pages are opened. With this control
and organization, administrators can develop
specialized components for specific team functions
by empowering users with streamlined automations.

Requisites:
• OAuth 2 Control Room configuration: Using secure credentials, configure a security token to validate

your identity as a licensed user. Servers will recognize this token and approve your access, eliminating
the need to log in multiple times to your accounts. Use AuthConfig App to enable OAuth2 services alla
pagina 2773

• Automation 360 v.26 or later
• Chrome browser
• AARI licenses: AARI Extensions uses teams and members to securely authorize and deploy content to

the right users.
• AARI fluency: Administrators should be familiar with the environment in order to identify key elements

used to map custom content to teams.

Additional considerations:
• Roles: Ensure that you have the proper role and permissions for your activity. AARI web interface users

alla pagina 2113
• Ensure that your browser is not blocking AARI Extensions access and windows.

Flusso di processo

The end-to-end workflow is illustrated in the following diagram.
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1. To begin accessing features, set up and connect your Control Room to AARI Extensions. Set up and
connect AARI Extensions alla pagina 2244

2. Develop and embed content in your preferred application for AARI Extensions. Develop a widget for
AARI Extensions alla pagina 2248

3. Administer your developed content to teams for users to access through AARI Extensions. Provisioning
AARI Extensions to teams alla pagina 2257

4. Get started using the embedded content through AARI Extensions. Deploy automations in web
application alla pagina 2234

Set up and connect AARI Extensions
Set up and connect AARI to AARI Extensions.
• Ensure that you meet all the prerequisites. Panoramica di AARI Extensions alla pagina 2242
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• Have your Service Account Token accessible to enter in setup. Create a service account for AARI
Extensions alla pagina 2247

Nota:  This token is an API key generated in the Control Room, from Settings.

AARI Extensions requires setup and connection of your system. Perform the following steps to complete
the setup illustrated in the following diagram.

© 2023 Automation Anywhere. All rights reserved.     2245



    Automation Anywhere - Crea

The following video shows the setup process.

1. To open the Extensions setup in a new tab with context about the AAI tenant, in AARI, click Connect
Accounts.

Nota:  Your Control Room URL and Partner ID will be automatically filled as part of the setup.

2. Select your Google or Microsoft account to begin the process of deploying and connecting AARI
Extensions to your Control Room.

3. Enter a Name for the new AARI Extensions Tenant that will be connected to your Control Room, for
example, Production.

4. In the Control Room settings:
a) Enter the Username of the Service Account that you created previously.
b) Enter the Service Account API Key to use for server-to-server communication.

5. Select Connect.
AARI is now connected to AARI Extensions, and you can assign developed content.
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Develop a widget for AARI Extensions alla pagina 2248

Create a service account for AARI Extensions
Create the service account and assign permissions to customize the AARI Extensions experience in your
embedded widget.
Use your AARI admin account (AAE_Robotic Interface Admin) to create a new user with the proper
role and permissions to configure the AARI Extensions experience.
Overview
1. Role: Create a new AARI role, with specific permission, to operate in AARI as the service account.

The permission you assign will structure the AARI Extensions experience.
2. User: After you set up the AARI role, create a new user and assign the role to administer permissions.
3. Key: Generate the API-Key of the user account that AARI Extensions will identify as the service

account. During setup of AARI Extensions, enter the API-Key.
4. Connect: Name the account to complete the AARI Extensions connection.

To grant permissions to the role:
1. Log in to your Control Room as an Admin user.
2. Navigate to Administration > Roles in the left-hand menu.
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3. Click Create Role at the top right of the page.
4. Enter the name for your new role and select the following permissions on the Features page.

These permissions enable the AARI Extensions server to query information to verify user access and
save metadata to AARI.
• Visualizza utenti
• Visualizza ruoli
• Visualizza le informazioni di base degli utenti e dei ruoli
• Visualizza licenze
• Genera chiave API
• Extension API for service account

5. Save your new role.
To create a new user for your service account and assign the role:
6. Navigate to Administration > Users in the left-hand menu.
7. Click Create User located at the top right toolbar to define a new service account user.
8. Enter information in the required fields and select the role you previously created and assign it to this

user.
9. Select Allow for Allow Multiple Sessions on the user creation page.
10. Fai clic su Salva.
To generate the API key:
11. Log in to the Control Room with the user you previously created.
12. Click your user name in the left-hand menu and then click My Settings in the profile card that

displays.
13. Select Generate API key at the top right of the My Settings page.

14. Save the API key to use when connecting AARI Extensions.

Set up and connect AARI Extensions alla pagina 2244

Develop a widget for AARI Extensions
Develop the iFrame widget in AARI Extensions to deploy in your web application.
• You must be logged in to the Control Room with AAE_Basic permissions.
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• Ensure that AARI Extensions is installed in your browser by completing setup. Set up and connect AARI
Extensions alla pagina 2244

• Set up the widget in AARI that will map automations into AARI Extensions. Setup iFrame widget using
AARI Integrations alla pagina 2225

• Have the widget embed code accessible to enter into AARI Extensions. You need only the URL in
quotes after src=.

With AARI Extensions, your Chrome browser will act as the vessel to embed the widget. Using the
following steps, develop an iFrame widget for your web application and deploy the widget to AARI to map
your complete embedded automation experience. While you can develop many web components, the
following steps streamline a simple process to bring automations directly into your web application.
The PixieBrix Page Editor environment is used to map and configure automations from AARI to your
web application and select the component for embedding the widget. This environment uses your OAuth
connection to access saved processes and automations from your Control Room and map them to the
selected component. For complete details on developing in the Editor, see the following link: Guide to
PixieBrix Page Editor
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The following video demonstrates the process of developing the widget in AARI Extensions.
1. To begin, navigate to the web application where the iFrame widget will be embedded.
2. Select the Render Panel action and delete it by clicking the trash icon on the top of the pane.
3. To open the page editor, from the desired web application, right-click and select Inspect.

The following table and image details the development environment.

Panel Descrizione

1 Extensions List Create and select an extension for development.

2 Extension Overview Add, view, and edit the components of the extension.

3 Configurations panel Map and configure how components interact with the
web page.

4 Data panel Test and debug your extension.

4. From Extensions List, click Add and select Sidebar panel.
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5. From the Overview panel, click the plus icon to open the component menu.
6. Select the iFrame component and click Add brick.
7. In the Configuration panel, complete the necessary fields.

a) Enter the Name of the widget. This name will appear in AARI when you begin provisioning to
users.

b) Enter the widget URL to access your Control Room.

This is the URL taken from the embed code found in AARI Integrations. You need only the URL in
quotes after src=.

8. Save your Extension.
9. Test and debug your extension by using the data panel.

The final output is detailed in the data panel and alerts you to any action that might be mapped or
configured incorrectly.

Importante:  If an alert for invalid connection or invalid credential appears, check that you have set
up and connected AARI correctly to AARI Extensions.

10. After successful verification, click the vertical ellipses in the Extensions List panel to add your
extension to a blueprint.

11. Select create new blueprint.
12. Select move or copy into the new blueprint.
13. Enter your unique id.
14. Enter the name to identify the extension in the next step.
15. Enter the version for developers to identify the progressive customizations made over the life of the

extension.
16. Enter a description.
17. Click Create to save your changes.

After developing the extensions for your team, deploy the blueprint to AARI Extensions. Deploy mod to AARI
Extensions alla pagina 2251

Deploy mod to AARI Extensions
Select and deploy the version of a verified extension for Teams to access in AARI Extensions.
Select and deploy an extension version (called a mod) for teams to access in AARI Extensions. Mods
package all customizations and return them to the web application as a single version. This provides
developers access to make improvements on one version while users simultaneously run a verified version.
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Use the management console in the AARI Chrome extension to deploy a mod and control the version of
developed artifacts.
AARI Chrome extension offers a management console for development artifacts to provide version control.
Select the version of an extension by choosing a mod from the console. Mods package all customizations
and return them to the web application as a single version. This allows developers access to make
improvements, while users run a verified version.
This task describes how to deploy a mod from the AARI Extensions management console to populate your
widget and make it accessible.
Prerequisiti
• Use a Google Chrome browser with a profile setup with AARI Extensions.
• Ensure you have access to two AARI users, one with the AARI admin profile for set up and one with the

AARI user profile for testing.

1. You can either:
• Open a new browser window on your machine and log in to AARI Extensions as an AARI

Administrator user; or
• Open a new browser window on a different machine to easier manage active sessions.

Suggerimento:  Use Chrome Profiles to manage multiple user profiles on the same machine. For
each user profile created, the user must log into AARI and install the Chrome extension into that
Chrome profile. Then, each user must log in to the Chrome extension using their respective AARI
credentials. This management method:
• Organizes profiles for Administrator, Developer, and end users for testing.
• Optimizes managing multiple sessions when tasks are completed on the same device.

To learn more about Chrome Profiles, see Google Chrome help

2. Open the Console page by selecting Chrome > Extensions > PixieBrix.
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3. Click the Options button in the slide out panel that appears.

4. If prompted to log in enter your Control Room URL and log in using the AARI Administrator user
account.

Nota:  To switch to a different user in the existing session, click Open Admin Console at the top
right of the page. In the new tab, click the username and select Logout.

5. When logged in as the AARI Administrator user, click Open Admin Console at the top right of the
page.
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6. Select Deployments from the left navigation menu.

7. Click + Create Deployment at the top right of the Deployments page.
8. Enter the name of your deployment.
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9. Select the mod of the extension you previously created using the Develop an widget for AARI
Extensions procedure. Develop a widget for AARI Extensions alla pagina 2248

10. Click Create Deployment to save your settings to AARI.
11. In a new tab or window, navigate to Automation Anywhere AARI and log in as an AARI Administrator

user.
12. Open the Extensions page by selecting Manage > Extensions from the left-hand navigation menu.
13. Click + Add Extension on the top right of the page.

Your newly deployed extension displays in the table.
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14. Select the check box next to your deployed extension and then click Add & Save.

You return to the Extension Setup page.
15. From the Extension Setup page, select the deployment you added.

AARI navigates to the Properties page.
16. To assign one or more teams, select the Teams tab at the top of the page.
17. Click the + button on the bottom right to open the Teams dialog.

18. Select the Teams for which to assign the extension.
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19. Click Add & Save to activate and deploy an AARI Teams customization.

Test the customization.

Nota:  If using Chrome Profiles, switch to a user profile dedicated to an AARI user profile that belongs to
this respective Team. Otherwise, follow the steps to log the user out of the Chrome extension and then log
in with a user that already has an AARI user license assigned and has been added to this respective Team.

As the user, navigate to your configured application, (similar to how Workday was configured in the
previous task). After you access the page configured on the Trigger, the Sidebar panel should automatically
display with the list of available automations for the user.

Provisioning AARI Extensions to teams
Organize and assign developed extensions to teams for business roles and functions.
Ensure that you have completed development of the AARI Extensions content. Develop a widget for AARI
Extensions alla pagina 2248
After developing an extension, make sure to refresh AARI to load recently developed content.
1. In AARI Extensions, click Add Extension.
2. Select the extension.

Recognize the extension by the Name you entered in development.
3. Click Add and Save
4. To edit properties, select the newly added extension on the Extension Setup page .
5. Click the Teams tab.
6. Select Teams to assign them the extension.
7. To commit your changes, click Add and Save.

The ellipsis on the far right of each team offers an option to send the extension link to users.
Users will now be able to access the widget from their web applications.

Check out what users can do with the extension. Deploy automations in web application alla pagina 2234

Embedded Automation example using AARI Integrations
An Embedded Automation widget is invoked as an Interaction Widget inside Genesys Cloud. The agent
uses the widget to correct a pricing error without leaving Genesys.
Embedded Automation
Business users can directly access authorized automation from within their favorite business applications,
without having to open a new interface or learn a new app. Embedded Automation delivers automation
everywhere you want, through a widget, either integrated with your web application or delivered through
a browser extension. To make the widget accessible, create and configure the widget in your preferred
application. Then populate the widget by assigning pre-built automations to teams in AARI. Those teams
can access Embedded Automation to complete daily tasks.
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Setup
1. Complete the setup process flow Panoramica di AARI Integrations alla pagina 2223
2. Assign automations Assign automations to teams alla pagina 2228
3. Automations assigned should include the following.

• Attended bot (that can be deployed on the local device) Attended and unattended automation alla
pagina 2179

• AARI Process invocation (with two human step forms) Distribuisci processi alla pagina 2155
• Unattended bot (triggered via AARI process with no human inputs) Crea un processo AARI alla

pagina 2133

Suggerimento:  Usable sample code
You can download the following sample code to test this example in your own environment. GitHub:
Embedded Use Case 1

Example Summary
In this example, a contact center agent receives a call about an order with an incorrect charge. The agent,
operating in Genesys, responds using the embedded widget by launching automated processes and bots,
and handles the order correction without leaving Genesys. Deployed automations touch Salesforce and
Zoho Sales Order Management to correct the error in respective systems. Assigned automations are
detailed in the following image.
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This example describes steps the agent takes to correct a pricing error while in Genesys, by using the
Embedded Automation widget.
1. Deploy the Salesforce Account Lookup bot and enter the phone number to pull up the account

record.

Copy the SFDC Order Number to enter in the next step.
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2. Launch the Order Items Price Correction process from within the widget and enter the order
number you have retrieved.
A Bot retrieves order details from Zoho and renders the Display Order Details in a form, including
products and prices paid.
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3. Correct the price on the item in question.

4. Optionally, select the 3% discount for courtesy.
5. Fai clic su Invia.

The bot calculates the amount to be reimbursed.
6. The bot creates a billing update for refund in Zoho.
7. A reference number is generated, and the system indicates it will take 5-7 business days for refund to

appear on card.

After the case is resolved, upload case notes from all cases handled through the day into a compliance
application for audit.
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Enter the file location, for the automation to sends notes to the appropriate contacts.

Embedded Automation example using AARI Extensions
Embedded Automation provides automation everywhere you want through a widget, either integrated with
your web application or delivered through a browser extension. You can use an embedded widget inside
Workday. For example, an Human Resource admin enters an employee address and can order business
assets to ship without leaving Workday.
Embedded Automation
Business users can directly access authorized automation from within their favorite business applications
without having to open a new interface, or learn a new app. You can invoke the widget in Workday. To
make the widget accessible:
1. Create and configure the widget in your preferred application.
2. Assign any pre-built automations in AARI required for teams to complete their daily tasks.

The widget (shown in the following image) populates assigned automations for specific roles.

Setup
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1. Complete the following setup process.
a. Set up and connect AARI Extensions alla pagina 2244
b. Setup iFrame widget using AARI Integrations alla pagina 2225
c. Develop a widget for AARI Extensions alla pagina 2248

Nota:  For this example, configure the widget to trigger as a Page Load event.

d. Provisioning AARI Extensions to teams alla pagina 2257

2. Two types of automations are assigned in this example and include the following details:
• Attended bot (that you can deploy on the local device). Consulta Attended and unattended automation

alla pagina 2179.
• AARI Process invocation (with two human step forms). Vedi Distribuisci processi alla pagina 2155

Suggerimento:  Sample code
You can download sample code to test this example in your own environment. See GitHub: Embedded Use
Case 2

Example Summary
An HR Admin logs into the Workday application and views the new widget sidebar on the home page that
has been deployed by the RPA Center of Excellence (CoE). The sidebar opens has been designed to open
automatically when the user accesses the Workday application and the page has completed loading.
The HR Admin can use Embedded Automation to access and update an employee address, and then order
hardware assets to deliver to that employee.
The deployed automations used in this example touch Workday and Zoho Sales Order Management (used
to complete the transaction):
• An attended bot (Employee Work Address Update) built for an HR Admin to quickly locate and

update home office address details of employees, using interactive forms and local desktop automation.
• An AARI process invocation (Device Order for Employee) built for an HR Admin to order hardware

assets (such as laptops and keyboards) for employees directly in Workday.
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1. Start the Employee Work Address Update automation used to enter the Employee ID of the
person you want to update.
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2. Enter the Employee ID to search Workday for the employee.

3. Enter the employee's address details using the provided form to update the employee data.
This example shows a simple address update. However, you can update other employee details based
on the available APIs in your Workday instance, or by using the Automation Anywhere Universal
Recorder.
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4. Click Save Changes.

The automation updates the employee data in Workday.
The second automation (Device Order for Employee) simplifies daily tasks of the HR Admin. This adds
an automated process for device ordering that is embedded directly in the Workday application using the
same sidebar. Typically, this task would require navigating procurement applications to locate and order
devices, and while navigating the Workday application to capture shipping address details of the employee.
By bringing the ordering process into the primary application where daily tasks are performed, the task is
simplified. Similar to the previous task, when the HR admin logs into Workday, the sidebar appears with
the list of available automations their CoE has deployed.
5. Locate the New Device Order for Employee automation displayed in the sidebar and click Start.

A new instance is created.

© 2023 Automation Anywhere. All rights reserved.     2268



    Automation Anywhere - Crea

6. Enter the Employee ID for a new order.

After submitting a valid Employee ID, the automation locates and returns the employee details within
Workday.
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7. Confirm the employee details and select the hardware items to order.
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8. After the automation has created a new order in the company's order management system (Zoho
Order Management), the automation returns the Sales Order number (SO-00012) for reference.

Embedded Automation example using AARI Extensions and AARI
Integrations
Embedded Automation provides automation everywhere you want through a widget, either integrated with
your web application or delivered through a browser extension. Have an employee submit an order request
and a manager approve the request.

Embedded Automation

Business users can directly access authorized automations from their favorite business applications without
having to open a new interface, or learn a new app. You can invoke the Embedded Automation widget as a
widget in ServiceNow or as a sidebar in SAP. To make the widget accessible:
1. Create and configure the widget in your preferred application.
2. Assign any pre-built automations in AARI required for teams to complete their daily tasks.

The widget populates assigned automations for specific roles.
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Example Summary

A company employee (Jane) submits a request to order replacement hardware. Jane (operating in
ServiceNow) uses the embedded widget to launch an automated bot to process the order, and submit
for approval to a Cost Center Manager (Gerald). Gerald (operating in SAP) uses the embedded widget to
launch automations that approve and complete the hardware shipment order.
The widget is visible in ServiceNow as a custom ServiceNow component that is placed into the Employee
Service Portal page. The widget is invoked as a sidebar through the web browser. For users operating in
SAP S/4HANA, the sidebar appears on a page load trigger.
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Setup

1. Complete the setup process flow for ServiceNow. Consulta Panoramica di AARI Integrations alla pagina
2223.

2. Complete the setup process flow for SAP. Panoramica di AARI Extensions alla pagina 2242.
3. Assign automations. Consulta Assign automations to teams alla pagina 2228.
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4. The embedded widget can contain combinations of three types of automations:
• AARI Process invocation (with two human step forms). Consulta Distribuisci processi alla pagina

2155.
• Attended bot (that can be deployed on the local device). Consulta Attended and unattended

automation alla pagina 2179.
• Unattended bot (triggered through AARI process without human input). Consulta Crea un processo

AARI alla pagina 2133.

Suggerimento:  Sample code
You can download the following sample code to test this example in your own environment. See GitHub:
ServiceNow.

Procedura

This embedded widget example includes the AARI Process automation type.
The Hardware Replacement Request AARI process allows an employee access to the business
ServiceNow Service Portal for IT requests. An employee can use the embedded widget to automate
requests. Jane's order request includes replacement hardware such as: keyboards, mice, or laptops.
When Jane opens ServiceNow, they can see the automated process for Hardware Replacement
Request within the widget.
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1. Jane initiates the Hardware Replacement Request and is taken to an input page in the widget
where they enters the information required to execute the automation.
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2. Jane can select the request for self, or as another employee, and click Submit.
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3. After submitting her request, the next automation connects Jane to the business HR system where
Jane gathers employee details, such as shipping address. The system connects to the procurement
system to to retrieve the available items to order.

Nota:  This example includes these steps in the automation to reduce reliance on additional systems.

4. This business rule was created in this automation example to check the total order value:
If the total order value exceeds the company threshold of $3000, then an approval is required from
the cost center owner. This generates a request to Gerald.
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5. Gerald focuses on different tasks in the cost management application (SAP). The list of automations
in the sidebar is focused on orders, inventory, and other sales related processes. When the widget
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generates Jane's request for Gerald, a toast message displays in the inbox for the new task in the
widget.

Gerald selects My Tasks to view the request and continue with the AARI approval process.
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6. Gerald approves the request and adds any comments, remaining in the SAP environment.
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7. Jane can see the details and status of each step in the overall process in the workspace widget. She
can see that all successful steps have completed, and an IT ticket has been created and closed to
track the request.

Getting started with Process Discovery
Process Discovery enables organizations to accelerate the automation of business processes and discover
the fastest path to process optimization and business ROI (return on investment). You can use Process
Discovery in various industries such as: healthcare, life sciences, and finance.

What is Process Discovery

Process Discovery is the first step in automation used to identify which processes can be automated in
a business. Process Discovery uncovers business processes by capturing user interactions with various
systems and analyzing the interactions to identify patterns. You can capture and analyze user interactions
with any of these systems:
• Enterprise solutions: ERP (enterprise resource planning), CRM (customer relationship management),

BPM (business process management), and ECM (enterprise content management)
• Personal productivity applications: Microsoft Excel and Outlook
• Terminal and virtual environments: Citrix XenApp and Remote Desktop
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Perché usare Process Discovery

Many companies begin their automation projects with manual observation and documentation. Manual
production and review of process documentation requires interviewing business users and mapping work
flows while they are performing daily operations. This involves additional resources which can be time-
consuming for all involved. This additional effort is also subject to inaccuracies due to users behaving
differently while being monitored. As a result, many of the automation opportunities remain undiscovered.
Process Discovery uses visualization tools to view process details and metadata, and review identical
processes that differ across regions, teams, or apps.

Scalable optimization capabilities

You can use Process Discovery to identify the processes in your business that you can automate. Process
Discovery helps you:
• Capture, parse, and analyze user interactions with various systems.
• Identify and map all relevant pathways (including variations) and automatically documents the most

common workflow.
• Compare the potential ROI from automating these processes and enables Business Analysts to

accelerate automation and maximize RPA ROI.
• Convert automation opportunities into bot prototypes using the Process Definition Document (PDD) for

further development and deployment by the Automation Developer.

Process Discovery end-to-end workflow

The following diagram shows the Process Discovery end-to-end workflow for Admin, IT, and power users:
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1. Set up users and assign Process Discovery roles.
2. Install Privacy Enhanced Gateway (PEG) in the On-premises Cloud to limit Personally Identifiable

Information (PII) and sensitive data capture.
3. Install Neo Sensor on multiple end-users (Observer's) machines for simultaneous process capture.
4. Verify and configure Observer data capture to ensure you only capture what you want.
5. Create cycles for event data based on groups of observers, applications used, or time frame.
6. Classify application screens and create web applications for mining.
7. Review events and filter data to identify key mining parameters.
8. Create mining runs to discover patterns and prepare for automations.
9. Map and compare workflows in data visualization tools. Prioritize processes based on ROI and select a

process for automation opportunities.
10. Select and annotate instances and create a Process Definition Document (PDD) for bot developers,

compliance, training, or process improvement.
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Process Discovery users
Learn about the various users in the Process Discovery platform and their privileges from creating mining
runs and exploring processes, to creating web applications and creating a Process Definition Document
(PDD).
The Process Discovery platform includes the following user types:

Administrator Creates users in the Process Discovery platform
and has administrative permissions to manage the
tenant, cycles, users, observers, and integrations.

Power user Creates mining runs, explore processes,
classifies application signatures, and creates
web applications. The power user does not have
administrator privileges.

Discovery user Creates mining runs and processes, and can review
events.

Limited user Can access only the Client Dashboard and assets
attached by a higher permission user.

Data Review user Selects and reviews data for all observers in the
Process Discovery platform. The data reviewer
user has access only to the Review tab and Data
Review page.

Create Process Discovery users and assign roles
As an Administrator user, you can create users and assign roles in the Process Discovery platform.
1. Log in to your Process Discovery platform as an administrator.
2. Click your account initials in the upper-right corner and select Manage Users.
3. Click Create User.

The Create New User window appears.
4. Enter the first name of the user in the FIRST NAME field.
5. Enter the last name of the user in the LAST NAME field.
6. Enter the email address of the user in the EMAIL field.

This is also the unique user ID for the user.
7. In the ROLE field, click the drop-down to select a Process Discovery role for the user.
8. To select an avatar for the user, click Choose Image file.
9. Navigate to an image on your computer and click Open to select the image.
10. Click Create User.

Process Discovery automatically generates and sends an email inviting the user to log in and use the
platform.

Nota:  If the user does not activate the account within 24 hours of receiving the email invitation, click
the Didn't receive confirmation instructions link on the login page to resend the confirmation
email. Enter the email address in the field provided and click resend confirmation instructions.

11. To reset a user password for a fully registered user, click Actions > Force Password Reset.
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12. Click Yes to reset the user password.
A message appears notifying you that the user will have to change their password on the next login
attempt.

Create your event reporting password
As an Administrator user, you can create your own password for the Event Reporting interface.
The Event Reporting interface uses Kibana which provides you reports about how people interact with
applications and screens. Using the reports, you can determine where to focus your process discovery.
1. To create your Event reporting password, log in to your Process Discovery platform tenant.
2. Click your account initials in the upper-right corner and select Manage Users
3. Locate your account details in the users list.

Suggerimento:  To quickly locate your account, click Filter. Enter your email address, select a role,
and click Apply.

4. In the Actions column, click the drop-down arrow and select Set Event Reporting Password.
The Set Event Reporting Password window displays.

5. Enter your password and click Set Password.
The password is ready to use the next time you log in.

Create a URL and application list
Learn how to create a domain list (containing the URL) and application list for data that you want to
capture or exclude on an Observers machine.
This task is performed by an Administrator. Before you configure Observer activity for data collection, you
create domain list and application list.
To create a domain list, perform the following steps:
1. Log in to your Process Discovery platform as an administrator.
2. Click your account initials in the upper-right corner and select Domain List.
3. Click Create List.
4. In the Name field, enter a name for the list.

For example, enter Business applications.
5. In the Type field, select Allow to capture URLs or Block to exclude the URLs.

Nota:  The blocked URLs will not be displayed in the screen shots from the Events page.

6. In the Domain field, enter the full URL address.
For example, enter www.servicenow.com, www.sap.com, or www.oraclefinancials.com.

Nota:  When specifying domains, you must explicitly indicate what domains to include or exclude. For
example, if chase.com is blocked, the secure05c.chase.com would not be blocked. You must include
secure05c.chase.com on the list.

7. Click Add to add the specified domain to the list.
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8. Click Create List.
You can now select this Block or Allow URL list from the Observers page for data you want to capture
or exclude, for an individual observer or group observers, based on your requirements.

To create an application list, perform the following steps:
1. Click your account initials in the upper-right corner and select Application List.
2. Log in to your Process Discovery platform as an administrator.
3. Click Create List.
4. In the Name field, enter a name for the list.

For example, enter Business applications.
5. In the Type field, select Allow or Block from the drop-down.
6. In the Application field, select an application from the drop-down or enter an application in the text

field.
7. Click Add to add the application to the list.
8. Click Create List.

You can now select this Block or Allow Application list from the Observers page for data you want to
capture or exclude, for an individual observer or group observers, based on your requirements.

Nota:  To create a default Block and Allow URL or Application list for all new observers in a tenant,
click your account initials in the upper-right corner and select Manage Account. In the Observer
Settings section, update the URL or Application Block and Allow List.

Configure Observer activity
As an administrator, you can configure an individual Observer or a group of Observers to capture or
exclude specific sets of data from collection on an Observers machine. This topic describes how to enable
or disable the capture settings (screenshots, keystrokes, title, and keyboard) and apply this to specific
applications.
After the Neo Sensor is installed on the Observers machine, ensure that you:
• Enabled the sensor recording. For more information on enabling or disabling the recording, refer to

Enable and disable the users recording alla pagina 2328.
• Created your domain and application list before you configure Observer activity.

Nota:  To enable or disable the recordings for new observers in a tenant, click your account initials in
the upper-right corner and select Manage Account. In the New Observer Recording section, select
Enable or Disable to set the recording configuration for all new observers. Fai clic su Salva per salvare le
modifiche.

To configure an individual observer or group configure observers for data collection with capture settings,
perform the following steps:
1. Log in to your Process Discovery platform as an administrator.
2. Navigate to Data > Observers.
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3. To configure all observers, select Configure <number> Observers.
This configuration is for all observers using the current filter. You can create filters for specific
departments in your organization (for example, HR or Finance) to filter data collection for a subset of
Observers. Click Filters to create filters.

4. To configure an individual observer, navigate to the Actions column for the Observer and select
Configure from the drop-down arrow.

5. In the Capture section, use the individual toggles to capture or exclude screenshots, keystrokes, title,
or clipboard globally for all applications.

6. In the URL Block and Allow List section, select one of the these options:
Opzione Azione

Nessuno No action to select. All URLs are captured by the
Neo Sensor.

Consenti Select the Allow URL list you created from the
Domain List page from the drop-down field.

Block Select the Block URL list you created from the
Domain List page from the drop-down field.

7. In the Application Block and Allow List section, select one of the these options:
Opzione Azione

Nessuno No action to select. All URLs are captured by the
Neo Sensor.

Consenti Select the Allow Application list you created from
the Application List page from the drop-down
field.

Block Select the Block URL list you created from the
Application List page from the drop-down field.

8. In the Configure Applications window, enter specific applications in the text field you want to
capture and click Add.
Based on your business needs and the applications you set to capture or exclude, you might need to
capture Screenshots and Titles for data processing of screen signatures.
The application is listed in the Application Name column.

9. To disable capture settings for the application, select the icon for Screenshots, Keystrokes, or Titles.
An X mark appears on the icon.

10. To configure observers by a single user, or group of observers with the same user name, select Use
configuration for observers owned by this user (<user name>).
This option is available for an individual observer only.

Nota:  When you use this option, the allow and block list that is created for new observers is used for
users with the same user name.

11. Click Configure.
The capture settings are now set for Observers.

12. To enable the capture settings for all observers by default, click your account initials in the upper-right
corner and select Manage Account.

13. In the Observer Settings section, perform steps 5 through 7.
14. Fai clic su Salva per salvare le modifiche.
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Create a cycle
Learn how to create a cycle for each data collection and add permitted users to the cycle so they can
access the associated events for data analysis. Cycles are defined as a collection of events based on a set
of Observers during a given time range.
Administrators have access to all event data, and can define which Permitted Users (Data Review,
Discovery, or Power user roles) can access the cycle data throughout the Process Discovery platform. The
Administrator informs users when the cycle is ready for them to review. Power users and all other non-
admin users do not have access to create their own cycles and cannot review data until the Administrator
creates the cycle for them. Creating a cycle for Power and all other non-admin users allows the users to
access the data to review events and mine for processes.
To create a cycle, perform the following steps:
1. Log in to your Process Discovery platform as an administrator.
2. Navigate to Data > Cycle.
3. Click New Cycle.
4. In the CYCLE NAME field, enter a name for the cycle.

Ad esempio: Cycle 1: Order Entry and Processing.
5. In the PERMITTED USERS field, select the users that you want to give access to.

Permitted users include only the Data Review, Discovery, or Power user roles. You do not need to add
Admins as permitted users because Admins can access all event data.

6. In the OBSERVED AT field, select the time data range from the Start date to the End date for the set
of Observers.

7. In the OBSERVERS section, you can multi-select Observers or Observer Users from the drop-
down lists. Alternatively, you can select a tag from the Observer tag drop-down list to populate the
Observers.
You can create Observer tags from the Observers page and can use them to identify a team for a
cycle. For example, the team is payroll or recruiting in HR where you can select as many Observers as
required. In a VDI environment, we recommend that you select Observers from the OBSERVER USER
section. This option enables you to easily select from hundreds of Observers and customize based on
the cycle you want to create.

8. (Optional) APPLICATION NAMES, click the drop-down list to select applications.
9. (Optional) In the START SIGNATURES, click the drop-down list to select a start signature.
10. (Optional) In the END SIGNATURES, click the drop-down list to select an end signature.
11. (Optional) In NOTES, enter any notes you want to share with the permitted users.
12. Click Create Cycle.

Classify application screens and create web applications
You can review unclaimed browser events such as Google Chrome, Internet Explorer, and so on, to assign
them to a specific web application.
When using web applications from the Process Discovery platform, the browser name is captured but
the web application or software as a service (SaaS) is not. Web application events (where the application
name is not captured) are stored in the Unclaimed Browser Events section of the Web Applications page.
To classify web application events that are related to the task or process, you must create specific web
applications for the events to be claimed in the application. From the Web Applications page, you can:
• Review events in the Unclaimed Browser Events section to locate and filter related process events from

their native browser applications. Typically, Google Search, personal searches, or web mail events are
not relevant to a task or process.
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• Create specific web applications that are used in the task or overall process flow, for example: Amazon
Web Services, Slack, Zendesk, and so on.

To review events in the Unclaimed Browser Events section and create web applications, perform the
following steps:
1. Log in to your Process Discovery platform as a power user.
2. Navigate to Data > Web Applications.

In the Existing Rules section, you will see previously created web applications. In the Unclaimed
Browser Events column, you will see various browser application events.

3. In the Unclaimed Browser Events column, click:
• Grouped by: Title to organize the browser events listed in the column by Title.
• Grouped by: URL to organize the events by URL.

4. To filter events in the column, use the data range option under the Unclaimed Browser Events header.
Select the start date (Month/Date/Year) and end date (Month/Date/Year). The events column will
update and display your results.
To filter events by specific event tiles, use the search icon. Enter the title in the search field. The
events column will update to display your results.

5. To view a browser event, click the link to view the set of events from the Events page.
The browser events with the highest frequency titles or URLs are displayed at the top of the column.
These are the most important events for processes that users are recording.

6. From the Events page, verify what web application the events belongs to.

Suggerimento:  We recommend that you note the web titles or URLs as you review the events
because you will create a web rule pattern (regular expression or regex) for each of the targeted web
applications. Additionally, you can use the Filter option to locate specific web applications by Observer
Name (for example) and click through the events in their workflow. Based on your situation, you might
filter on URLs because URLs are unique, whereas titles are not necessarily unique. For example, if you
have two applications with HOME as the title, you should use a URL web based rule instead of the
title.

7. From the Unclaimed Browser Events column, continue to review the set of browser events from the
Events page and determine if the events need to be claimed as web application events.

8. After you have located the titles or URL that you need to create web applications, navigate back to the
Web Applications page.

9. Click Create Web Application.
10. In the APPLICATION NAME field, enter the name of the application.

For example, enter Google Search ICD 10 Lookup.
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11. In the APPLIED RULE TYPE section, select the rule type (Title or URL) to use.
For example, select Title.

12. In the RULE PATTERN (REGEX) section, enter a pattern that matches the title or URL of your target
application in the text box.
For example, enter icd10 lookup in the text box. We recommend that you remove "Google Search"
from the application name because there may be similar events (icd10 lookup) in other browsers that
you can also include in the rule pattern.
You can also click the copy icon to copy the title of the web application and paste into the text box.

For example, you only need the title, KTBSonline and there are two KTBSonline titles listed in the
browser events column. The two titles are:
• Verify Login Information | KTBSonline - Google Chrome
• Enroll in Open Enrollment Benefits | KTBSonline - Google Chrome

To capture the events from both titles, you can enter the rule pattern as: Verify Login Information \|
KTBSonline - Google Chrome|Enroll in Open Enrollment Benefits \| KTBSonline - Google Chrome, or
you can just enter KTBSonline and keep the rule pattern simple.
Continuing with the example for KTBSonline, the backslash (\) character precedes the vertical (|)
character to indicate that this is not an OR function in the rule.
To include more than one title in the rule pattern, use the vertical bar (|) character to indicate the OR
function. For example, to include results for PDFfiller OR pdfFiller, enter the rule pattern as: PDFfiller|
pdfFiller.
The caret (^) character is another commonly used character for creating web rules. Use the caret
character at the beginning of the rule pattern when you want to match the exact event title at
beginning of the text. For example, you want events only where KTBSonline is at the beginning of the
text in the application. In the text box, enter the rule pattern as: ^KTBSonline.

13. Fai clic su Crea.
The system takes a few minutes to create the web application. To verify that the rule is updated, click
the magnifying glass icon in the Actions column. After the web application has completed, a pop-up
notification appears in the bottom left corner.

Review Events and filter data
You can review and filter Events collected from the Observers machine to develop mining insights.
We recommend that you collect Observer events for at least two to five weeks to ensure that all processes
assigned to Observers are completed before data analysis. After a few weeks of collecting Events, you can
review the Events. From the Events pages, power users can:
• Review events to ensure that data is collected from Observers.
• Use the Filter option to sort and display events by single or multiple Observers, application, Observed

at (date range), and so on.
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• Enlarge individual screens to view Observer events (mouse clicks and keystrokes) in detail.

To review and filter Events, perform the following steps:
1. Log in to your Process Discovery platform as a power user.
2. Navigate to Data > Events.
3. In the upper left side, click the drop-down to select an Observer.

By default, all Observers events are displayed on the Events page.
The events collected by the Observer are displayed in the Events table. The total number of Events
collected by the Observer is displayed in the Events text box above the table.

4. Click through the event IDs to view the date range (Observed At), Application, Title, and Field
columns.
Click the gear icon to select additional data to view. The selected data displays a green checkmark. For
example, you can select Screen signatures, Application, Field, and so on. The data displays in another
column within the Events table.

Nota:  In the Events table, the Observed At date and time range is the time that a user is looking at
the events in the application. The Observed At date range is not related to the Observers location.
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For example, if the Observer is in India and the user is looking at the events in the application in
California, the Observed At date and time is in California time.

For each Event ID, the associated Event screen appears to the right. The following image and table
describe the metadata (1-4) details associated with the screen and the icons (5 and 6) used to enlarge
the image.

Metadata Descrizione

1 Event ID The ID number associated with the event.

2 Observed At The exact date (Month/Day/Year) and recording time
of the event captured by the Observer.
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Metadata Descrizione

3 Signature The application screen associated with that event.
Each application has a unique ID.

4 Screen Signature A unique label pattern applied to an application screen
to enable process mining.

Nota:  Although, Screen signatures are partially
automatic, modifications are required for data mining.
As long as the Screen Signature is logical, multiple
Events may share the same Screen Signature. It is
important that Screen Signatures describe the screen
appropriately because they enable further process
mining.

When you are ready to modify your Screen Signatures
work, we recommend that you work with a Process
Discovery Business Analyst.

5 Image Viewer icon Enlarges the image to full screen mode.

6 Dispositivo di
scorrimento

Expands the width of the image.

5. Click Filter to customize the events you want to view.
Filtering events allows you to better understand the individual steps as part of the overall process you
might optimize. For example, you might refer to the Field column for potential start and end tasks of
process.

6. To filter events for a cycle, select a cycle from the Cycles drop-down and Click Apply.
The Events table is updated and updates events for that cycle.

7. To filter events using a set of rules with conditions (AND, OR) or create a group (combination of
rules), select from the following options or a combination of options:
Opzione Azione

Add Rule A Rule is single condition. Use this to add additional conditions, such as AND, OR. Refer
to the AND,OR examples for more information.

E Filter events only which satisfy BOTH conditions will be included.

For example, the AND operator is
selected and you select Application
Name = Acrobat and Application

Type = web. The filer rules include
events from both Acrobat and web.
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Opzione Azione

O Filter events only which satisfy
EITHER condition will be included.
For example, the OR operator is

selected and you select Application
Name = Chrome and Application

Type = windows. The filter
rules will include only events

EITHER in Chrome or in windows.

Aggiungi
gruppo

Use this to filter for a combination of rules. A Group can also be a collection of Groups,
or a mix of both.

For example, there is a combination
of Groups, each with their own
group of Rules, collected by an
OR operator. The filter rules will
include events that are either
(on machine AAIComputer_7

AND in Chrome) OR (on machine
AAIComputer_4 AND in Excel).
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Opzione Azione

Operators Select from one of the following operators:

Opzione Risultato

= The condition is equal to the input. Ad esempio: Application
Name=Google. This filter rule will include events where the
application is Google only.

>, < The condition is greater than, or less than those in the input.
Ad esempio: ID > 1000. This filter rule will include events
where the ID is greater than 1000.

Nota:  This applies only for Observed At and ID conditions.
The Observed At filter is the quantity of any event that is
recorded in that exact time.

>=, <= The condition is greater than or equal to, or less than or
equal to those in the input.

Nota:  This applies only for Observed At and ID conditions.

Nota:  The examples provided include some of the more commonly used operators.
The full list of operators include:
• In
• !=
• Not In
• Is Null
• Is Not Null
• Matches

8. Click Apply to apply your filter settings and view events.

Select and annotate instances
Before you create groups for the process and generate the Process Definition Document (PDD), you can
select and annotate instances.
• Before you create a PDD, you create a mining run from the Mining Runs page. (Alternatively, you can

also create a PDD from a set of events from the Events page using the Import to Graph option.)
• From the Process Explorer page, review the various paths taken by the observers, where the thickest

path is the most frequent path taken.
• Identify the path you want to view from an event-level.
• Click the View in Instances Viewer icon to navigate to the Instances Viewer page where you can

select and annotate events to include in a PDD. You can also select a process to annotate directly from
the Instances Viewer page.

1. Log in to your Process Discovery platform as a power or discovery user.
2. Navigate to Data > Instances Viewer.
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3. In the upper-left side next to View Instances, click the drop-down to select a process to visualize.

4. After the process displays on the page, click the drop-down to select the instance to include in the
PDD.

5. Click the gear icon to add the Include in Process column.
The Include in Process column provides you a check box for each line order (refer to the Order
column) used to specify which steps to include in the PDD.

6. Click Annotate to update field labels for the selected steps. For all steps that you want to include in
the PDD, leave the box checked and update the action and label from the screen on the right.
Two fields will appear above the screen image.

7. From the drop-down, select a Control Type.
The Control Type refers to the selection performed in the application.

8. In the text field, enter a control label description for the Control Type and click Update.
We recommend that you enter a label description that corresponds with the label in the screenshot so
that when users review the PDD, the output makes sense to them.
For example, select Button from the Control Type drop-down and enter Click New Ticket in the
description field.
The Ann column will display user and the Field column will display the description entered in the text
field.

9. Repeat steps 6 through 8 for all steps that you want to annotate.
The Save Instance to Process button is enabled for all checked items that include both a label and
description. You must annotate all instances you want included in the process for the Save Instance
to Process button to appear.

10. Click Save Instance to Process.
The View Process Details button appears.

11. Click View Process Details to name the process.
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12. In the Name field, enter a name for the process using this suggested format: 5577-21245E Instance
1 for <Mining Run><Process><Path><Instance>.

13. Click Save Process to save the process with a name.
A message appears at the bottom left side notifying you that the process is saved successfully. Click
the hyperlink to return to the Process Explorer page. You can now create groups for the events and
generate a PDD.

Creating groups for the process and generate a PDD
Learn how to create different groups with start and stop events, and use the groups to design a Process
Definition Document (PDD).
After you selected your instances, you can create groups for the events and build your PDD.
1. Click Create Group to place the steps in different groups for the PDD.

You can create groups for tasks that are part of the process.
2. In the Create Group window, drag a step from the process workflow and move it into the Start

Node.
The Start Node is the beginning of the task. For help building the group of steps as tasks in the overall
process, refer to the View Instances page for the selected screens. For example, to create tasks
related to completing fields on a checkout page, you can
• Group all steps in one group and name the group Checkout; or
• Create multiple groups for individual tasks like Add Payment in one group or add Shipping address

in another group.

3. Select the last step in the group and place the screen in the End Node(s).
The End Node(s) is the end of the task.

4. Enter a name in the Group Name text box.
5. Select a color for the group from the drop-down next to the Group Name text box.
6. Click Save to save the group.
7. Repeat steps 2 through 6 for all steps you want to group.
8. Open a new browser tab and navigate to the Process Discovery platform.
9. From the left pane, navigate to Models > Diagram Composer.

In the Browser Processes and Groups section, the instances and groups are displayed.
10. Click the + sign to add a flow box for each group.

Each flow box appears on top of the previous box. Move these boxes into a row or column. The
groups are listed in reverse order from when they were created.

11. To connect one flow box to another flow box, click the > on the side of the flow box and drag the
arrow to connect the boxes.

12. To document a process with branches, click the Decision Point.
A diamond share flow box appears in the composer.

13. In the Details window, click the pencil symbol to enter a name for the decision point.
14. Repeat steps 10 through 13 until you have completed adding flow boxes for all groups in the PDD.
15. Click Auto Layout to display any missed connections.
16. Update the flow boxes as needed.
17. To save your PDD, specify a name in the text field and click Save.

The Generate PDD button appears.
18. Click Generate PDD to start generating a PDD.
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19. Select Yes or No to include an image appendix.
The image appendix includes full-sized screen shots of the steps.

Nota:  The default images for each step is a zoomed-in snippet of the events interaction point.
The events interaction point is the area on the screen where the user is focused which is typically
denoted by a red circle on the screen shot.

The Process Specifications page appears and the message Generating PDD displays in the bottom left
corner.

20. Click Download PDD to open the PDD document.
The generated Word document is available from your Downloads folder on your machine. The zip file
contains all the images.

21. Review and modify the document, (if needed) and then save your PDD.

Getting started with Privacy Enhanced Gateway
Control the data that the Process Discovery cloud platform receives by using the Process Discovery Privacy
Enhanced Gateway (PEG). PEG redacts sensitive data that is included in video frames collected by the
Process Discovery desktop sensor. This redaction occurs within your own Virtual Private Cloud (VPC) before
the data is forwarded to the Process Discovery cloud for analysis.

Distribuzione

Before installing PEG in your network, review the deployment platforms supported by PEG, virtual machine
(VM) size requirements, and storage requirements.

Obtaining PEG

PEG runs as a VM in your VPC. PEG deployments are supported on Microsoft Azure, AWS, and Google
Cloud Platform. Automation Anywhere will provide cloud images for you to deploy.

VM size requirements

The following VM sizes are supported for PEG installation:
• Azure: NC8as T4 v3
• AWS: g4dn.4xlarge
• Google Cloud Platform: N1-highmem-8 with 1 nvidia-tesla-t4 GPU

Nota:  Each PEG VM can handle 10 sensors per calendar week, with each sensor sending data for
approximately eight hours each day for five days a week.

Common storage requirements

Before you install PEG, ensure that your OS or root disk has 2 TB of nearline SSD storage or more. Encrypt
the disk using your platform’s storage encryption mechanisms.

© 2023 Automation Anywhere. All rights reserved.     2300



    Automation Anywhere - Crea

Deployment and networking requirements
Learn about the deployment architecture based on certificates for HTTPS connections and the associated
port and DNS requirements.

Distribuzione

With this deployment model, all connections to PEG remain within networks that you control.
Architecture

Port requirements

The following table lists the port requirements for ingress and egress IP addresses.
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Porta Protocollo Purpose Ingress
private IP

Ingress
public IP

Egress
to public
internet

22 TCP ssh connectivity for Admin #

443 TCP Ingress
Desktop sensor and business
analyst connectivity over HTTPS
(TLS 1.2)
Egress
PEG sends redacted data to
Process Discovery.
Also used to pull down PEG
installer, updates, and so on from
our repositories
Sensor connects directly to
Process Discovery cloud to get
configuration information only.
No collected data is sent directly
from the sensor to the Process
Discovery cloud.

# #

80 TCP Used for redirection from http to
HTTPS (443)

#

DNS requirements

You will provide PEG with an apex domain name that you want to use (for example, example.com). Based
on that, PEG will inform you about the DNS sub domain records that you must create.

Install PEG
Review the checklist before you begin installing PEG in your environment.
Ensure that PEG VM is deployed and that the network connectivity is set up.
PEG installation checklist
The details for each of these steps follow later.
1. Create certificates.
2. Create DNS entries and deploy PEG VM.
3. Configure PEG to work with a proxy (if you require a proxy).
4. Configure PEG by following the regular set of steps.
5. Validate that PEG is running.

Nota:  Through the installation process, replace the values within angle brackets with your actual values
and remove the angle brackets. Ad esempio:
• <apex domain> might be replaced by example.com.

© 2023 Automation Anywhere. All rights reserved.     2302



    Automation Anywhere - Crea

• <UID> might be replaced by 123456ab-789c-12de.

Create certificates
Create certificates as part of installing PEG.
You can create certificates by using one of two options.
• Option 1: PEG generates keys and CSRs.
• Option 2: Create your own keys and certificates.

In both cases, you will need the following:
• Unique ID (UID): Each PEG VM you run must have a unique id. You can define the UID to be anything

you want as long as it meets the following criteria:
• Less than or equal to 18 characters in length
• Contains only letters from a to z, numbers from 0 to 9 and/or hyphens
• Must not begin or end with a hyphen
• Must not contain consecutive hyphens
• Suggerimento:  To easily create a UID, take the last 18 characters of a GUID generated from an

online GUID generator.

• The apex domain that you want to use for the PEG DNS names (for example, example.com)

Option 1: PEG generates keys and CSRs
Learn how to use PEG to generate the keys and CSRs for you.
1. Log in to PEG through ssh.

If you do not log in as user named peguser, then ensure that you switch to the peguser per this
command before performing these steps.
sudo su - peguser

2. If you already have a unique ID (UID) by Process Discovery, run the following command: echo
 "<UID>" > ~/.kudzu/appliance.txt, where UID is the unique ID that you were provided. If
you do not have a UID, the next few steps will generate one for you.

3. Run cd peg && ./peg_start.sh.
4. Select Cluster management.
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5. Select Generate Certificate Requests.

6. Fill out the options that follow.
7. Exit the menu.
8. Please record the UID value that you see in the output of this command: cat ~/.kudzu/

appliance.txt

The CSRs are located in ~/peg/csr.
9. Create certificates from those CSRs per Common Tasks - Creating the certificates alla pagina 2304 below.

Option 2 - Create your own keys and certificates
Learn how to create keys and certificates before you deploy PEG.
Keys and certificates must be in Base64 PEM format (called openssl or PKCS #8 for the key format in some
systems). Create certificates according to Common Tasks - Creating the certificates alla pagina 2304. Keys
must not be password protected. Also, ensure that your keys match the file names in the Key File Name
column of, Tabella 3: Mapping of domain names to certificate file names alla pagina 2304.

Common Tasks - Creating the certificates
Learn how to create Base64 PEM certificates.
When you create the certificates, create six server Base64 PEM certificates (called openssl format in some
systems), with domain names and file names mapped as follows, where the UID is provided to you by
Process Discovery and the apex domain is your apex domain that you will use for PEG. Each certificate you
create must just contain the leaf certificate and not the full chain.

Tabella 3: Mapping of domain names to certificate file names

Dominio Cert file name Key file name (Required only if
you created your own keys)

analytics-fiq-<UID>.<apex
domain>

analytics-cert.pem analytics-key.pem

proxy-fiq-<UID>.<apex
domain>

proxy-cert.pem proxy-key.pem

storage-fiq-<UID>.<apex
domain>

storage-cert.pem storage-key.pem

st-fiq-<UID>.<apex domain> st-cert.pem st-key.pem

dlp-fiq-<UID>.<apex domain> dlp-cert.pem dlp-key.pem

es-fiq-<UID>.<apex domain> es-cert.pem es-key.pem

klite-fiq-<UID>.<apex domain> klite-cert.pem klite-key.pem

Nota:  You can create one certificate with all of the SANs. You can also create just one key if you create
keys if you want. However, you will still need to make sure there are seven copies of that certificate and
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seven copies of that key (if you created keys) named as indicated previously. Do not create a wildcard
certificate.

Create DNS entries and deploy PEG VM
Create DNS entries and deploy PEG VM as part of installing PEG.
Create DNS entries where each domain mentioned in Tabella 3: Mapping of domain names to certificate file
names alla pagina 2304, points to the PEG VM (PEG must have a static IP or a static domain name).

Configure PEG to work with a proxy
Configure PEG to use a proxy for outbound traffic if required.
Deploy PEG VM

Nota:  When you deploy the PEG VM, ensure that it has a static IP or at least a static domain name. To
configure the VM static IP address, use the mechanism provided by your VPC provider.

1. Log in to the PEG VM through ssh.
2. Copy your proxy certificate, if one is required, to the following locations:

Nota:  The proxy file name must have a .crt extension and must be in the Base64 PEM format (called
openssl format in some systems).

• sudo cp <your proxy certificate.crt> /usr/local/share/ca-certificates/

• sudo cp <your proxy certificate.crt> /peg_v/certs/

3. For the OS to load the certificate, run the following command: sudo update-ca-certificates
4. Add the following to the /etc/environment file (including the username and password if

required) using the http_proxy and https_proxy values for your environment.

Nota:  Although this is not a requirement, the https_proxy value is often the same as the http_proxy,
with the protocol being HTTP for both.

Enter the URL in the following format: <your http/https proxy url> Enter the username and
password if required.http://username:password@host:port/

---

http_proxy=<your http proxy url> https_proxy=<your https proxy url> 

no_proxy="localhost,::1,127.0.0.0/8,0.0.0.0,10.0.0.0/8,192.168.0.0/16,172.16.0.0/12"

5. Log out of your ssh session and then log back in.
This allows the proxy settings to be picked up by the operating system.
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6. Edit the following values as follows in ~/peg/text_pipeline/values-gpu.yaml. (These values
are at the bottom of the file).
Enter the URL in the following format: <your https proxy url>. Enter the username and
password if required. http://username:password@host:port/

If you do not use a certificate for the proxy, fluentd_cert_path should be left as follows: ""

---

has_fluentd_proxy: "true"

fluentd_cert_path: "/peg_v/certs/<your proxy.crt>" 

https_proxy: "<your https proxy url>"

---
7. If you performed the steps in Set up and configure PEG alla pagina 2306 before performing the proxy

steps outlined in the previous steps, perform the following steps:
a) Run cd peg && ./peg_start.sh .
b) Select Cluster Management and press Enter, and then select Load Certificates and press

Enter again.

Set up and configure PEG
Configure PEG for your environment.
If you require a proxy configuration, first perform the steps outlined in Configure PEG to work with a proxy
alla pagina 2305.
Ensure the following:
• Unique ID (UID) provided by Process Discovery
• Platform endpoint provided by Process Discovery
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• PEG-managed certificates: the apex domain that you want to use for the PEG DNS names (for example,
example.com)

1. Log in to PEG through ssh.

Nota:  If you do not log in as user named peguser, then ensure that you switch to the peguser before
performing these steps: sudo su - peguser.

2. Run the following commands:

echo "<apex domain>"  > ~/.kudzu/apex_domain.txt 

echo "<UID>" > ~/.kudzu/appliance.txt

echo "127.0.0.1" > ~/.kudzu/external_ip.txt

echo "CSRs Generated" > ~/.kudzu/csr_log.txt

3. Modify the existing values in ~/peg/text_pipeline/values-gpu.yaml as seen here. Do not include a slash
at the end of the URL.

external_fluentd_url: "https://<FortressIQ provided platform endpoint>"

external_fluentd_port: "443"

4. Confirm that the PEG VM can reach the Process Discovery platform by running the following: curl
 https://<FortressIQ provided platform endpoint>
Viene visualizzato il seguente messaggio:
400 Bad Request
'json' or 'msgpack' parameter is required.
Although that result is an error response, it is expected as the curl is not sending a well-formed
message. The response confirms that the server received the request and responded.

5. Copy the PEG certificates that you created to /peg_v/certs/ directory.
Ensure that they are named according to the certificate file names in Tabella 3: Mapping of domain
names to certificate file names alla pagina 2304.

6. If you also created your own keys, copy the PEG keys that you created to the /peg_v/keys/ directory.
Ensure that the keys are not password protected. Also, ensure that they are named according to the
certificate file names in Table 1.
If you did not create your own keys, the PEG-generated keys are automatically included by PEG.

7. Run ~/peg/scripts/validatecerts.sh.
To confirm that the certificates are valid, continue only if the script passes with "All checks passed!"

8. Reboot to ensure that any updated drivers are applied correctly: sudo reboot now
9. Run cd ~/peg && ./peg_start.sh.
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10. Select Redaction Management and press Enter, and then select Install module and press Enter
again.

Nota:  Do NOT install cluster.

11. Select Vault Management and press Enter, and then select Install Module and press Enter again.

12. Select Storage Management and press Enter, and then select Initialize Storage and press Enter
again.
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13. Select Cluster Management and press Enter, and then select Load Certificates and press Enter
again.

14. Change the analytics page password. Run the following and enter your password. cd ~/peg/
scripts/ && ./change_elastic_password.rb

Nota:  The username for logging in to https://analytics-fiq-<UID>.<apex domain> is admin.

15. Add storage users as needed . You will need at least one user with at least read access to confirm that
PEG works. These are the users that can review the redaction of the images. ~/peg/scripts/add-
storage-user.rb .
This script also gives you the option to create users that can edit the pass-and-block (allow/deny) list.

Nota:  The username that you create corresponds to the Access Key in the login page for https://
storage-fiq-<UID>.<apex domain>. The password corresponds to the Secret Key.

Configuration is now complete.

Validate PEG is running
Verify whether your PEG configuration is operating correctly in review mode.
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To confirm that PEG is running as expected, perform the following steps:
1. In a browser, go to https://storage-fiq-<UID>.<apex domain>.

You will see a screen like this: ("Access Key" = "your username" and secret key = "your password")

2. Log in to https://storage-fiq-<UID>.<apex domain> using a user you created in the
configuration steps previously (by running ~/peg/scripts/add-storage-user.rb on the VM).

3. After you log in, you will see these folders on the left. If you do not, run the "Storage Management"
"initialize storage" steps in the configuration steps. If you still do not see them after that, contact
Process Discovery.
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4. In a browser, go to the analytics URL: https://analytics-fiq-<UID>.<apex domain>
Verrà visualizzata una schermata simile alla seguente:

If you do, go to the next step.
5. In a browser, go to https://dlp-fiq-<UID>.<apex domain>.

You will just see a blank page. If you encounter an error or it times out, then there is something
wrong.

6. Install the Neo Sensor on a Windows machine. Open a web page, such as https://www.fortressiq.com
and then click the page several times.

7. After 10 minutes (which is the approximate duration for review images to be generated), log in to
https://storage-fiq-<UID>.<apex domain>. Log in with one of the storage users that you
created previously in the configuration steps.
Note on the folders on the left side:
• fiq-screenshots: Shows the screenshot that PEG received
• forwarded: Shows what the screenshot looks like if it is forwarded. This is populated regardless of

whether it was actually forwarded or not.
• review: PEG adds annotation to the images here to show more clearly what will be redacted. PEG

includes a blue rectangle around where the redacted word previously existed and includes the text
it found above the rectangle.

8. Click the fiq-screenshots folder on the left.
9. Download some of the images from this folder and confirm that they look like the results of your test.
10. Click on the review folder.
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11. Download some of the images from this folder and confirm that they appear to be from your test. If
PEG finds words that must be redacted, PEG includes a blue rectangle around where the redacted
word existed and it includes the text it found above the rectangle, as follows.

If this looks as expected, you have validated that PEG is working in review mode.

PEG modes overview
Redacted images are processed in one of two modes, the review mode and the forwarding mode.
PEG can run in one of two modes:
• Review mode
• Forwarding mode

Review mode

This is the default mode for PEG when it runs for the first time. In this mode, you can review the redacted
images, make changes to the pass-and-block lists, and so on, without PEG forwarding data to the Process
Discovery cloud.

Forwarding mode

When you are comfortable with the results of your review of the images, you can enable the forwarding
mode. After that, PEG will redact sensitive data from newly incoming images and send the redacted data
to the Process Discovery platform. (Existing images from review mode will not be forwarded.)

Switch between modes
Change PEG to the forwarding mode and then back to the review mode.
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By default, PEG initially starts in the review mode.
1. To switch to the forwarding mode:

a) Edit the ~/peg/text_pipeline/values-gpu.yaml file. At the end of the file, change the
forward_to_fluentd value to true and save the changes.
forward_to_fluentd: "true"

b) Push the change to PEG by running the following from any folder:

source ~/peg/scripts/vars.sh

kubectl delete cronjob.batch/text-pipeline-masking-masking-cron -n
 text-pipeline

kubectl get pods --output=jsonpath={.items..metadata.name} -n text-
pipeline -o=name | grep cron | xargs -n1 kubectl delete --grace-
period=0 --force -n text-pipeline

helm upgrade text-pipeline ${text_pipeline_dir} -f ${values_file_t}
 --namespace text-pipeline --set ocr.name=st-fiq-$new_gen_uuid.
$apex_domain --set masking.name=dlp-fiq-$new_gen_uuid.$apex_domain

2. To switch back to the review mode:
a) Edit the ~/peg/text_pipeline/values-gpu.yaml file. At the end of the file, change the

forward_to_fluentd value to false and save the changes.
forward_to_fluentd: "false"

b) Push the change to PEG by running the following from any folder:

source ~/peg/scripts/vars.sh

kubectl delete cronjob.batch/text-pipeline-masking-masking-cron -n
 text-pipeline

kubectl get pods --output=jsonpath={.items..metadata.name} -n text-
pipeline -o=name | grep cron | xargs -n1 kubectl delete --grace-
period=0 --force -n text-pipeline

helm upgrade text-pipeline ${text_pipeline_dir} -f ${values_file_t}
 --namespace text-pipeline --set ocr.name=st-fiq-$new_gen_uuid.
$apex_domain --set masking.name=dlp-fiq-$new_gen_uuid.$apex_domain

Determining content for redaction
PEG redacts words for forwarding based on the pass and block lists.
PEG determines the words that must be redacted base on two lists:
• The pass list
• The block list
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The pass list

PEG comes with a built-in pass list. This list is based on our experience with customers. It contains all the
words that PEG will not redact. Only words in the pass list will be included in images and other data sent to
the Process Discovery platform. Words not on the pass list will be redacted.

The block list

The block list is a list of words that PEG will redact. PEG redacts words based on this list first before it
processes the pass list. The block list is useful in situations where you know words exist on the pass list
that you want redacted, but you do not want to have to modify the pass list. For example, a common use
case is that some people's names are also everyday words that appear on the pass list by default. You can
create a block list of all of the names of your employees or common names in various countries, which can
be obtained from the Internet.

Modify the pass and block lists
Modify the pass list or the block list in the dictionaries folder.
To modify the pass list or the block list, perform the following steps:
1. Log in to https://storage-fiq-<UID>.<apex domain> as a user who has access to edit the pass and

block lists.
2. On the left navigation menu, select the dictionaries folder.
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3. In the dictionaries folder, you will see the block-list.txt and pass-list.txt files as follows.

4. Select the files that you want to edit and download them.

5. Edit the list that you want to edit by using any text editor. Ensure that each word that you add to
either list is followed by space and the number 1.
account 1
customer 1
user 1

Nota:  Use all lowercase letters for all the words.
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6. Upload the modified files (named "pass-list.txt" or "block-list.txt" accordingly) to the same dictionaries
folder. This will overwrite the existing files and apply your changes. The upload button is at the
bottom-right corner of the page. Click plus (+) sign and then the upload icon.

Manage redaction and forwarding settings from the UI
Manage your forwarding and redaction configurations, and export logs from a simplified UI interface.
You can use the Privacy Enhanced Gateway (PEG) UI interface to perform administrator tasks such as:
1. Update an existing pass list with new words or upload a new list.
2. Set the forwarding settings (true or false) to send redacted data to the platform.
3. Forward existing events that were previously recorded on a users machine.
4. Download and review PEG logs (including logs for the last 24 hours).
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See the following video on how Process Discovery PEG uses a web UI to manage redaction and forwarding
settings instead of running commands on a Command Line Interface (CLI).

Manage redaction list configurations
Learn how to manage your redaction configurations from the Privacy Enhanced Gateway (PEG) UI and
export logs, instead of running commands on the Command Line Interface (CLI).
To update your redaction settings from the UI, perform the following steps:
1. Log in to your PEG klite URL platform as an administrator: https://klite-fiq-<UID>.<apex

 domain>.
2. In the upper right-corner, navigate to Admin > PEG configuration.
3. In General Settings, select Redaction List.
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4. In the Pass List section, select from the following options:
Opzione Azione

Upload new list document Click to upload a new list of words. The words
on this list are not redacted and are sent to the
platform. Words are on this list typically do not
contain sensitive, private information (such as
credit cards numbers, phone numbers, names,
and so on).

Nota:  Any word that is not on the pass list is
redacted.

<pass-list>.txt a. Click to edit the existing pass list. The list is
saved in the Downloads folder.

b. Open the file, add your changes, and save
the file.

c. Click Upload new list document to upload
the document.

A pop-up message appears notifying you that the
pass list is updated successfully.
Each line can only contain one word. A word can
contain letters, numbers, and symbols, but no
spaces. For words with numbers and symbols,
those words will only be used for comparison if
the Cleaning field is set to false. The words are
case-insensitive. For more details about cleaning,
see step 11.

Text field Enter the words in the text field to update the
existing pass list followed by the Enter key. For
example, to update the pass list to include a
category (such as Support), enter Support in the
text box followed by the Enter key.

5. Click UPDATE to save your changes for the pass list in the text field.
6. Click CLEAR ALL to clear your changes in the text field and start over.
7. In the Block List section, select from the following options:

Opzione Azione

Upload new list document Click to upload a new list of words. The words
are on this list are redacted and not sent to the
platform.
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Opzione Azione

<block-list>.txt a. Click to edit the existing block list. The list is
saved in the Downloads folder.

b. Open the file, add your changes, and save
the file.

c. Click Upload new list document to upload
the document.

A pop-up message appears notifying you that the
block list is updated successfully.
Each line can only contain one word. A word can
contain letters, numbers, and symbols, but no
spaces. For words with numbers and symbols,
those words will only be used for comparison if
the Cleaning field is set to false. The words are
case-insensitive. For more details about cleaning,
see step 11.

Text field Enter the words in the text field to update the
existing block list followed by the Enter key.

8. Click UPDATE to save your changes for the block list in the text field.
9. Click CLEAR ALL to clear your changes in the text field and start over.
10. In the Redaction Word Filter Setting section for Fuzzy Matching, select true to allow Optical

Character Recognition (OCR) some level of variation (fuzzy matching) to consider a word a match. By
default, Fuzzy Matching is set to true and PEG does not require an exact match when comparing a
word with a word on the pass for the block list. Select false to disable fuzzy matching.

Nota:  When reviewing the redaction levels, you might find some sensitive text (that is not on the
allow list) displaying unexpectedly in the applications screenshots. In that case, select false to disable
fuzzy matching to provide a preferable result.

For example, if OCR reads a word as kello. There is a chance that OCR might be right or wrong in how
it reads the word kello. Kello is not in the pass or block list. Kello might be considered a close enough
match to hello (with the idea that kello was just OCR misreading hello). So, if the word hello is in the
pass list, then the word kello would also be allowed and not redacted.

11. In the Cleaning field, click the drop-down to select true to remove all non-alphabetic (anything not
a letter in the alphabet) from a detected word before comparing it to the words in the dictionaries.
Select false to allow numbers for cleaning. By default, cleaning is set to true.

Nota:  Cleaning defines whether non-alphabetic characters should be ignored when comparing a word
with the dictionaries.
For example, there are category types (PURCH2A, PURCH2B, and PURCH2C) that are a mix of
numbers and letters that appear in your application screens that should not be redacted. To ensure
that PURCH2A, PURCH2B, and PURCH2C are not redacted, add the words to the allow list and disable
cleaning. PEG will not remove the numbers from these words when comparing with the words on
the allow list. Another example is if you have an account ID, such as SA31LE. If cleaning is set to
true, then PEG removes the number 31 from SA31LE and compares the word, SALE with the words
in the allow list. If SALE is in the allow list, then it is not redacted. However, if you set cleaning to
false, cleaning compares SA31LE with the words on the allow list. Since SA31LE is not in the allow list,
SA31LE is redacted.
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12. Click UPDATE to save your changes.
A pop-up message appears notifying you that your changes are successfully deployed.

13. To export logs from the UI, click Export Logs.
The logs begin generating. After the logs have generated, click Download Logs to unzip the logs
from the Downloads folder. The log files contain information about the system (including logs for the
last 24 hours).

Manage forwarding configurations
Learn how to manage your forwarding configurations from the Privacy Enhanced Gateway (PEG) UI instead
of running commands on the Command Line Interface (CLI).
To update your forwarding settings from the UI, perform the following steps:
1. Log in to your PEG klite URL platform as an administrator: https://klite-fiq-<UID>.<apex

 domain>.

2. In the upper right-corner, navigate to Admin > PEG configuration.
3. In General Settings, select Forwarding.
4. In the Forward to platform field, select true to forward redacted data platform, or select false to

prevent sending forward redacted data to the platform.
By default, the Forward to platform field is set to false.

5. In the Port for forwarding field, the default port number is 443.
We recommend that you leave the default port number as 443 unless you need to change it.

6. In the Forward live records field, select true to forward the live events to the platform, or select
false to prevent sending any events to the platform.
You can use this setting to forward new incoming events. It will not forward existing events that are
masked. If you select false, the incoming events are redacted, but not sent to the platform.

7. In the Forward existing masked records field, select true to forward existing events that were
already recorded but have not been sent to the platform. Select false to prevent sending any existing
events collected on your machine to the platform.
You use this field only to forward data that was previously collected. For example, you might have
collected events for two weeks and forgot to send the events to the platform.

8. In the UTC start date for forwarding field, enter the start date for the observed at date range. The
observed at date range is when the Neo Sensor recorded the event on the machine. You must specify
the range in the UTC time zone.
Based on the date range you enter, PEG forwards previously redacted events that were not already
forwarded to the platform.

9. In the UTC end date for forwarding field, enter the end date for the observed at date range.
10. To use a proxy, click the Use Proxy checkbox.
11. In the https proxy field, enter the proxy URL address to use.

If required, include the username and password in the URL: http://username:password@host:port/
12. Click Deploy.

Manage disk space
Manage disk space by managing the duration for which images are kept in the review folder.
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When the disk usage is over 80 percent, PEG stops processing new messages. To manage the setting in
the review folder, perform the following steps:
1. Add the following block of code to the end of the ~/peg/text_pipeline/values-gpu.yaml file.

(Alternatively, if an entry already exists, modify it.)

 #Archive Info 
 review_retention_days:  365  

The value that you include here will be the number of days for which PEG will keep an image in the
review folder. Replace the number 365 with the number of days for which you want to retain review
images. This will affect only the review images. The original images and the images in the forwarded
folder will not be affected.

2. Push the change to PEG by running the following from any folder:

source ~/peg/scripts/vars.sh

kubectl delete cronjob.batch/text-pipeline-masking-masking-cron -n text-
pipeline

kubectl get pods --output=jsonpath={.items..metadata.name} -n text-
pipeline -o=name | grep cron | xargs -n1 kubectl delete --grace-period=0
 --force -n text-pipeline

helm upgrade text-pipeline ${text_pipeline_dir} -f ${values_file_t} --
namespace text-pipeline --set ocr.name=st-fiq-$new_gen_uuid.$apex_domain
 --set masking.name=dlp-fiq-$new_gen_uuid.$apex_domain

Renew and replace certificates and keys using PEG
In the customer-managed certificates deployment model, certificates and keys that are set to expire are
not renewed and replaced automatically.
When your certificates are set to expire, you must perform the following tasks to renew them:
1. Create a new certificate. You can create a new certificate with two options:

• You can choose to have PEG create the new certificate signing request and the keys, or
• You can create your own certificates and keys. To create your own certificates and keys, see Create

certificates alla pagina 2303.

2. Upload the new certificate. To upload the new certificate, see Upload the new certificates alla pagina
2322.

If you choose to have PEG generate new keys and the certificate signing requests, perform the following
steps:
1. Run cd peg && ./peg_start.sh.
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2. Select Cluster Management.

3. Select Generate Certificate Requests.

4. Enter information for the options that follow.
5. Exit the menu.

The certificate signing requests are located in ~/peg/csr.
6. Create certificates from the CSRs that PEG generated. Per ulteriori informazioni, consulta Common

Tasks - Creating the certificates alla pagina 2304.

Upload the new certificates
Learn how to upload the new certificates and keys after they are created.
1. Copy the PEG certificates that you created to the /peg_v/certs/ directory.

Ensure that you name them according to the certificate file names in Tabella 3: Mapping of domain
names to certificate file names alla pagina 2304.

2. If you also created your own keys, then copy the PEG keys that you created to the /peg_v/keys/
directory.
Ensure that the keys are:
• Not password protected
• Named according to the certificate file names in Tabella 3: Mapping of domain names to certificate file

names alla pagina 2304

Nota:  If you choose to have PEG generate the keys, then you do not need to perform this step. The
PEG-generated keys are placed into a folder for you.

3. To confirm that the certificates are valid run ~/peg/scripts/validatecerts.sh.
Continue to Step 4 only if the script displays: All checks passed!

4. To load the latest certificates, run the following command on PEG:

kubectl rollout restart deployment.apps/traefik -n kube-system
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Create image viewer user in analytics portal
Learn how to create an image viewer user and add the user to the analytics portal. Use the image viewer
to find, view, and compare images in PEG.
To create a user in image viewer user and add a user to the klite_read_only role in the analytics portal,
perform the following steps:

Nota:  The image viewer uses the same logins as those used in the PEG analytics portal.

1. In a browser, go to the analytics portal: https://analytics-fiq-<UID>.<apex domain>
2. Enter your admin username and password.

Your admin password is the same password as the elastic password you set when you configured PEG.
3. Go to Security > Internal users.
4. Click Create internal users.
5. In the Create internal user form, enter your username and password.
6. Fai clic su Crea.
7. Go to Security > Roles.
8. In the search field, enter klite_read_only.
9. Click klite_read_only.
10. Select the Mapped Users tab, and click Map Users.
11. Select the users you want to map.
12. Click Map.

Users can now log in to the image viewer.

Configuring image viewer
Before you can use the image viewer, you must configure it.
The image viewer requires you to step up the user configuration for first-time users (or if you have to clear
cookies you will have to configure it again).
If you are using PEG for the first time, perform the following steps to use the image viewer.
1. To open the image viewer application, enter the following address in a web browser: https://

klite-fiq-<UID>.<apex domain>

2. In the Configuration Settings dialog box, click Getting started.
3. Enter your klite username and password.

Enter the username and password that was created for new image viewers users. Per ulteriori
informazioni, consulta Create image viewer user in analytics portal alla pagina 2323.

4. For Index Pattern, from the drop-down list, select event_logs.
5. For Image Key Field, from the drop-down list, select screenshot_key.
6. Click Continue.

You can now use the image viewer.

Using image viewer
Use the image viewer to view the images in buckets that are used frequently.
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Before you begin, configure the settings as mentioned in Configuring image viewer alla pagina 2323. You
can use the image viewer to see images in the following buckets:
• fiq-screenshots: This includes the screenshot that PEG received.
• forwarded: This is what the screenshot looks like when it is forwarded. This is populated regardless of

whether it is forwarded or not.
• review: This includes annotated images. PEG adds annotation to the images to clearly show what will

be redacted. PEG puts a rectangle around where the redacted word previously existed and includes the
text it found above the rectangle.

To review the images, perform the following steps:

Nota:  These steps show you the buckets that are used frequently, but you can change the selection as
needed.

1. Log in to the image viewer.
The image viewer application is located at your PEG klite URL: https://klite-fiq-<UID>.<apex
 domain>

2. In Bucket 1, click the pencil icon to select the bucket you want.
For example, select fiq-screenshots.

3. In Bucket 2, click the pencil icon to select the bucket you want.
4. Select the timeframe within which you want to review the data.

For example, select Last 15 days.
5. Click Refresh.

If images were sent during the selected timeframe, you can see them now The Bucket 1 version of the
screenshot is on the left. The Bucket 2 version of the screenshot is on the right. You can move the bar
in the middle to the left and the right to see the difference between the two.

Nota:  If you just sent in an image, it might not be displayed for 10 minutes.

6. Click Filters to filter the data to only look at a specific set of screenshots.
For example, click Add filter to see all notepad screenshots for a specific user.

7. Click Configure Field to select what fields you want to see above the screenshot.
For example, select the Application, Screenshot_key, and Title fields. The image viewer displays
these fields above the screenshot.

8. To export images, select the Export image icon located in the top-right corner of the page.
The Export Images window appears.

9. Select the image range from 1 to 10 using the modal bar.
10. Select the slot from the drop-down list.

For example, select slot 1.
11. For Export Option, choose from the Selected Range option or the Random option.
12. Click Download.

Neo Sensor application
Use the Neo Sensor to record activity on a user’s machine to determine what business processes are
candidates for automation.
The Automation Anywhere Process Discovery Neo Sensor is a lightweight application that integrates
to the machines’ video card to record user activities. The sensor operates in both thick and thin client
applications, and across multiple monitors. You can configure which applications and domains can be used
to capture activity.
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Requisiti di sistema

The following system requirements are supported for installing the Neo Sensor:
• Operating Systems

• Physical Desktop: Windows 10, Windows 11
• Citrix VDI: Windows Server 2016, Windows Server 2019

• Memory: 4 GB di RAM
• Required software packages: .NET 4.7 or later

Installing Neo Sensor
Learn how to install Neo Sensor on your machine.
Ensure that you install Neo Sensor as a user on your machine, and not on a system level. Any user
with privileges to run an MSI installer, and write permissions to their own user folder, can perform the
installation. If you are using Microsoft SCCM or other software deployment solutions to deploy the MSI,
make sure it is deployed as the user you are deploying it to.
1. Obtain the msi package from Automation Anywhere.
2. Unzip the msi file if you have received it as a zip file.
3. Double-click the Neo2 MSI to launch the Installation Wizard.
4. Fai clic su Avanti.
5. Click Next to continue with your organization, endpoint, and port information.

Your customer information is already populated in the fields provided.
6. Click Install on the Ready to Install Process Discovery Neo2 window to begin the installation.
7. Click Finish to exit the Setup Wizard.

The installation is complete and the Neo Sensor is now running. A Neo2 shortcut displays on your
desktop and a pop-up message displays informing you that Neo Sensor has started recording. The
Process Discovery (IQ) icon is displays in your system tray.

8. To quit the recording, right-click the Process Discovery icon in the system tray and click Quit.
A message displays that the recording has stopped. To restart the recording, double-click the Process
Discovery icon Neo2 shortcut on your desktop.

Nota:  Depending on how the Sensor is configured, the quit option might not be available.

Nota:  After you enable the Observer and install the Neo Sensor, the recording will automatically start
even after a system reboot. To prevent the Neo Sensor from automatically recording, click the caret
symbol on the taskbar to access the system tray. Right-click the Process Discovery icon in the system
tray and select Quit.

Uninstalling Neo Sensor
Learn how to uninstall Neo Sensor on your machine.
In a centralized deployment, IT will uninstall Neo Sensor. If you choose to manually uninstall Neo Sensor
from your system, perform the following steps:
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Nota:  Before you begin uninstalling Neo Sensor, ensure that you close the Neo Sensor application on your
system.

Nota:  Uninstalling Neo Sensor from the Observers machine will not delete the previous recordings from
the Process Discovery Cloud.

1. Navigate to Windows > Control Panel > Programs and Features.
2. Right-click the Process Discovery (IQ) icon and click Uninstall.
3. Click Yes to uninstall.

Nota:  If you receive a pop-up message informing you that the following applications should be
closed before continuing the install, select, Automatically close applications and attempt to
restart them after setup is complete and click OK.

Installing Neo Sensor in a VDI environment
Learn how to install the Neo Sensor in a Virtual Desktop Infrastructure (VDI) environment and create a
portable package.
Many VDI environments do not allow msi installs that install as the user, especially if they are non-
persistent desktops. If the msi installer does not work in your environment, you must create a portable
installer on a machine with access to the Automation Anywhere Process Discovery platform.
1. Install the Neo Sensor using the MSI installer. For more details, see Installing Neo Sensor alla pagina

2325.
Ensure that Neo Sensor is running. The Neo Sensor icon displays in the bottom right corner of the
system tray.

2. Navigate to C:\Users\<username>\AppData\Local\Programs\Neo2 and copy the files that
the Neo Sensor installer created in that folder to a different folder.
For example, you can name the folder Neo Sensor files.

3. In Windows Explorer, search in Add or remove programs.
4. Locate the Neo Sensor app and remove the program.

This removes the existing install folder and the registry settings.
5. Copy the Neo Sensor files that you put in a folder to any folder on the VDI server.
6. Create a startup script to start the Neo2.exe on login for users that will run the Neo Sensor.

By default, the Neo Sensor needs write access to the folder it is running from because that is where
the Neo Sensor writes the logs and downloads the configuration from the platform. Since the Neo
Sensor runs in the user space, users need write access to that folder. If you do not want users to have
write access to that folder, you can specify a different writable folder to store the logs and the Neo
Sensor configuration. For more details on storing the logs and sensor configuration to a writable folder,
see Modifying the log and configuration storage location alla pagina 2327.
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Modifying the log and configuration storage location
Learn how to change the location of the logs and the Neo Sensor configuration storage folder to a folder
that is writable to all users who have the Neo Sensor running on their machine.
1. Copy the NeoRemoteConfig.json file to the folder where you want to store it.

The NeoRemoteConfig.json file is one of the Neo Sensor files you should see in your portable
installer folder. The folder you copy it to must be the same writable folder where you want to store the
logs.

2. Set the log and config file location by specifying the absolute path to the new folder in the
Path.config file. In the folder with the Neo2.exe, there should be a Path.config file.
For example, your Path.config file might contain: z:\user_shared_storage
\neo2_logs_and_config.

You can assign it to an absolute path or can use one special reserved variable {MyDocuments}.
If you use the {MyDocuments} variable in the Path.config file, the logs will be stored in a folder
named Neo2 in the user’s Documents folder.

Nota:  The Neo Sensor expects to see the NeoRemoteConfig.json in that folder.

Verify Neo Sensor Installation
Use the log files to verify that the Neo Sensor is installed correctly on your machine.
1. While the Neo Sensor is running and in recording mode, click a few times anywhere on your machine.

Clicking a few times on your machine triggers the Neo Sensor to collect and send a screenshot to the
Platform which results in entries in the Neo Sensor logs that you can use for validation.
For more details on enabling the Neo Sensor in recording mode, see Enable and disable the users
recording alla pagina 2328.

2. From Windows Explorer, open the C:\Users\<username>\AppData\Local\Programs\Neo2
folder. If you changed the default location for the logs, then open the folder you have changed it to.

3. Locate this log file: Neo_<machine name>_<userid>.log
4. Double-click to open the log file.

If the Neo Sensor is working as expected, the following lines display as an example towards the
bottom of the log file. If everything is correct, a job number displays, followed by OK.

2022-11-08 22:03:39.3775 TEST\testuser
 com.FIQ.Neo2.Utility.Network.RawLogForwardingPostConsumer [INFO] Worker
 id: 5b1bd418-2e19-4097-8ba7-31af6f22bd0a, queue size: 0, current job 152
 OK, time elapsed: 0ms, type: fiq.win.keylog

2022-11-08 22:03:39.3775 TEST\testuser
 com.FIQ.Neo2.Utility.Network.RawLogForwardingPostConsumer [INFO] Worker
 id: 61849714-b916-43b7-8878-eced56dd1d65, queue size: 0, current job 151
 OK, time elapsed: 5ms, type: fiq.win.screenshot

If the Neo Sensor is not working, you will see words such as error and failed in the log files output.

Nota:  If you experience issues, please contact Automation Anywhere for assistance.

2022-11-08 14:13:32.5720 TEST\testuser
 com.FIQ.Neo2.Utility.Network.RawLogForwardingPostConsumer [ERROR]
 Worker id: bbe8547d-3c67-473d-a328-e949a7c25a03, queue size: 13,
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 current job 2 failed, type: fiq.win.screenshot, time elapsed:
 10ms, System.AggregateException: One or more errors occurred. ---
> Flurl.Http.FlurlHttpException: Call failed. An error occurred
 while sending the request. POST https://test.example.com:443/
fiq.win.screenshot ---> System.Net.Http.HttpRequestException: An error
 occurred while sending the request. ---> System.Net.WebException: The
 remote name could not be resolved: 'test.example.com'

Enable and disable the users recording
Learn how to enable or disable the Observers recording in the Process Discovery platform.
1. Log in to into the Process Discovery platform.
2. Navigate to Data > Observers.
3. Identify the Observer you want to enable or disable the recording.
4. From the Actions column, click the drop-down arrow to enable Start Recording for that Observer.

To disable, select Stop Recording for that Observer.

Process discovery by using Discovery Bot
You can use Discovery Bot to identify the processes in your business that can be automated. Discovery
Bot identifies such processes by recording and analyzing user interactions with various systems for
processes, comparing the potential ROI from automating these processes, and creating bots to automate
the processes.

What is process discovery

Process discovery is the first step in automation, in which the processes that can be automated in a
business are identified. Process discovery is a method used to uncover business processes by recording
user interactions with various systems and analyzing the recorded interactions to identify patterns. User
interactions with any of the following types of systems can be recorded and analyzed:
• Enterprise solutions, such as ERP, CRM, business process management (BPM), and ECM
• Personal productivity applications, such as Microsoft Excel and Outlook
• Terminal and virtual environments, such as Citrix XenApp and Remote Desktop

Perché usare Discovery Bot

Many companies begin their automation projects with manual process discovery and documentation.
Manual review of process documentation requires interviewing business users and mapping work flows
while performing daily operations involving additional resources, which can be time-consuming for
businesses. This additional effort prevents or delays businesses from reaching the decision to automate
their processes and reaping the benefits of automation. As a result, many of the automation opportunities
are left undiscovered. Discovery Bot allows businesses to assess ROI from potential opportunities that can
help with deciding and implementing automation for their processes.
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Capabilities

Discovery Bot helps in the following ways:
• Enables automatic process documentation and analysis, thereby saving time and resources
• Identifies the correct processes for automation for business users and citizen developers
• Enables business analysts and RPA developers to accelerate automation and maximize RPA ROI
• Converts automation opportunities into bot prototypes for further development and deployment by the

automation developer

How Discovery Bot is used

The Discovery Bot administrator creates processes and invites business users through an email invitation
to participate in the recording of these processes. Business users record the steps they perform for
various business processes. Discovery Bot aggregates the recordings and generates a proposed work flow.
The business analyst can adjust the work flow to select and merge steps into branches from different
recordings. From the work flow, the analyst identifies and prioritizes potential automation opportunities
based on ROI. Opportunities are approved by the analyst, and Discovery Bot converts the opportunities to
TaskBots for deployment.
The following image illustrates how Discovery Bot supports your automation journey from process
discovery to bot creation.

To view Discovery Bot tasks in an interactive visual format, see Get started with Discovery Bot.
For an overview of how to get started with Discovery Bot, watch the following video:

See Get started with Discovery Bot.
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Introduzione a Discovery Bot
Discovery Bot enables organizations to accelerate the automation of business processes from process
discovery to bot creation.
• Ensure the system requirements are met.

Prerequisiti per Discovery Bot alla pagina 2335
• Install and configure Discovery Bot for users in your organization.

Installing Control Room On-Premises alla pagina 838

1. Set up users and assign Discovery Bot roles.
Assign Automation 360 users with the relevant Discovery Bot permissions and associated licenses.
• Discovery Bot utenti alla pagina 2330
• Supported licenses for Discovery Bot alla pagina 2332
• Creazione di utenti per Discovery Bot alla pagina 2338

• Create multi-role users for Discovery Bot alla pagina 2339
• Create a custom role for Discovery Bot alla pagina 2342
• Assign the Discovery Bot custom role to a user alla pagina 2343

2. Set up the business process within your organization.
Create a placeholder for collecting all of the recordings associated for a given process. Invite one or
more users through email notification to a Discovery Bot process recording session.
Create a Discovery Bot process alla pagina 2344

3. Record the process.
Business users record their work for the associated processes, annotate their steps, and submit for
review a proposed automation work flow.
• Supported applications and browsers for Discovery Bot alla pagina 2347
• Registrare un processo aziendale Discovery Bot alla pagina 2348
• Registrazione di processi Discovery Bot con AARI Assistant alla pagina 2353

4. Analyze the process.
The relevant business users (subject matter experts (SMEs), RPM or business analysts (BA)) review
the recording data and opportunities associated with the process for specific usage patterns.
Analisi delle opportunità di automazione alla pagina 2354

5. Create opportunities. Merge specific recordings or steps as required. Prioritize opportunities and
generate bots automatically.
• Esame delle opportunità, conversione in bot e creazione di PDD alla pagina 2355
• Using the Filter and Toggle frequency counter options alla pagina 2361

Discovery Bot utenti
Various users are involved in the discovery process, and each user's role and responsibility helps in
identifying potential automation opportunities for a business process. The streamlined workflow in
Discovery Bot enables various users to collaborate without changing their operations in a major way.
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Discovering processes for automation involves the following users:

Control Room administrator Creates other users, assigns roles to users, and
assigns Discovery Bot licenses for users

Discovery Bot administrator Creates, edits, and deletes processes; also,
associates Discovery Bot roles to and disassociates
Discovery Bot roles from processes
Users with the Discovery Bot administrator privilege
cannot view the recorded data of any process,
participate in the recording analysis, or create new
opportunities for automation.

Discovery Bot business user Represents the task force in an organization that
will benefit from process automations. The business
user performs the following associated tasks for
business processes:
• Performs the steps in the assigned process and

records the steps
The business user is responsible for recording
the steps in the process that are being reviewed
and evaluated for potential automation
candidates. The business user is invited to
participate in recording session by the Discovery
Bot administrator.

• Edits the Step description (annotated user
text) field for recordings.
For each recording, the business user can
review the recorded screen captures and provide
annotations to capture the business context for
the analyst to review. The business user can
update the Data (keyboard entered) text field
if the information should not be shared with the
analyst, for example, user ID and password.
If the captured steps are not relevant to the
process, the business user can delete the steps
before submitting the recording for review.

Nota:  After a recording has been submitted, it
cannot be edited.

• Controls the recording of processes using the
media control symbols on the Discovery Bot
recorder.
Users can start, pause, resume, and stop the
recording on demand by using the Discovery Bot
recorder to capture the relevant steps for each
process.

Nota:  After the recorder has been stopped,
additional steps cannot be inserted into that
recording.
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Discovery Bot analyst This user can also be known by other names in
an organization, such as process owner, process
analyst, business analyst, or subject matter expert.
The Discovery Bot analyst is responsible for
reviewing the associated recordings and identifying
potential candidates for automation. The analyst
can perform the following steps:
• View all approved recordings from assigned

users for a given process.
The analyst cannot edit the recordings; however,
they can merge the necessary variations from
multiple recordings and create an aggregate
view of the process.

• Create opportunities from individual recordings
and the aggregated view created from multiple
recordings, and convert the opportunities into
bots.

• Export a potential opportunity to a Word
document for reference.

While it is not a prerequisite for the analyst to
be knowledgeable about the processes they are
reviewing, it is beneficial because this knowledge
helps in easily selecting and analyzing the
recordings.

Supported licenses for Discovery Bot
Learn about the supported Discovery Bot licenses to ensure business workers are ready to begin using
Discovery Bot.
Per gli analisti aziendali e gli utenti aziendali che utilizzano Discovery Bot devono essere acquistate le
licenze Process Discovery. Discovery Bot supports two licenses:
• Process analyzer license for the Discovery Bot analyst

This license allows a user to view and manage the metadata from all recordings within the process and
create, view, and manage opportunities created from the recordings.

• Process recorder license for the Discovery Bot user
The process recorder license allows a user to view, record, and submit a process using the Discovery
Bot recorder.

The following table displays detailed information for supported licenses and permissions for Discovery Bot
business workers:
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Utente Discovery Bot System-provided
Discovery Bot role

Funzionalità Discovery
Bot

Discovery Bot license
required

Discovery Bot admin AAE_Discovery Bot
Admin

• Create, view,
update, and delete
processes.

• Assign Discovery
Bot analyst and
business user to
processes.

Nessuno

View assigned
processes.

Nota:  Assigned
processes are only
displayed after the
processes are created
by the Discovery Bot
admin.

Analizzatore di processi

View only recordings
(including annotated
steps and metadata)
that they have created
or been assigned to. An
Analyst can also view
recordings of other
users in the process
as long as they are in
Approved state.
If a user is no
longer assigned to
a process, the user
will lose access to the
recordings.

Analizzatore di processi

View all recordings
(own and other users),
including metadata and
annotated steps, for a
given process.

Analizzatore di processi

• Create, view,
update, and delete
manual generated
aggregation

• View all manually
generated
aggregations

Analizzatore di processi

Discovery Bot analyst AAE_Discovery Bot
Analyst

Create and view own
opportunities for a
given process.

Analizzatore di processi
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Utente Discovery Bot System-provided
Discovery Bot role

Funzionalità Discovery
Bot

Discovery Bot license
required

Convert an opportunity
to a bot.

Process analyzer for
opportunity creation.
Bot Creator license is
required to convert an
opportunity to a bot.

Export opportunity to
Word.

Analizzatore di processi
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Utente Discovery Bot System-provided
Discovery Bot role

Funzionalità Discovery
Bot

Discovery Bot license
required

Utente Discovery Bot AAE_Discovery Bot
User

• Using the Discovery
Bot recorder, create
or more recordings
for an assigned
business process.

• Update own
recording to include
annotations for the
steps.

• Delete one or more
steps from own
recording before
submission.

• View only
recordings
(including annotated
steps, keyboard
entered text, and
application type)
that they have
created or been
assigned to. The
user can update the
keyboard entered
text field if the
information should
not be shared
with the analyst
(e.g. user ID and
password).

Nota:  Assigned
processes are only
displayed after
the processes
are created by
the Discovery Bot
admin.

If a user is no
longer assigned to
a process recording,
the user will lose
access to the
recording data.

Registratore di processi

Prerequisiti per Discovery Bot
Per utilizzare Discovery Bot per i processi aziendali, è necessario disporre di un ambiente di lavoro
Automation 360 e delle dipendenze associate installate: Bot Agent, estensione del browser e così via.
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Versioni supportate e requisiti del server

Verifica che sia installata la versione della Control Room corretta. La distribuzione della Control Room può
essere su cloud o in sede.
Assicurati che i requisiti del server della Control Room siano impostati prima dell'installazione. Consulta
Control Room server requirements alla pagina 844.

Requisiti di sistema
Per i processi di registrazione degli utenti Discovery Bot o i privilegi di creazione dei bot assegnati, verifica
che il dispositivo soddisfi i seguenti requisiti di sistema:
• il computer Windows è supportato solo per le sessioni di registrazione.
• Oracle database is not supported on Discovery Bot.
• Imposta le credenziali del dispositivo locale per qualsiasi dispositivo connesso alla Control Room. Si

tratta di una configurazione una tantum per ciascun dispositivo. Assicurati che ogni dispositivo utilizzato
accetti le credenziali del tuo profilo.

• Set user device credentials alla pagina 1052
• Registra il dispositivo e installa la versione Bot Agent più recente sul computer. Se non hai già installato

Bot Agent al momento dell'accesso iniziale, verrà richiesto di installare Bot Agent dalla scheda
Processi. Follow the prompts to install the Bot Agent. This will automatically add your user credentials.
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039

• Per registrare i processi utilizzando Google Chrome, è necessario installare il plug-in di Chrome.
Requisiti del browser per RPA Workspace alla pagina 866

• Assicurati che l'ambiente sia pronto per iniziare a registrare e analizzare i processi utilizzando il
registratore Discovery Bot. I prerequisiti sono simili a quelli del Universal Recorder.
Record a task with the Universal Recorder alla pagina 1951

• Verifica che i requisiti del registratore Discovery Bot siano stati soddisfatti.
Supported applications and browsers for Discovery Bot alla pagina 2347

Aggiornamento delle impostazioni del proxy

È necessario aggiornare le impostazioni del proxy per aggiungere il dominio URL di Automation Anywhere
all'elenco attendibile. Il dominio URL aggiunto è specifico per la tua regione del cloud Automation
Anywhere. Se stai usando il tuo proxy per accedere al nostro cloud, devi evitare un reindirizzamento al tuo
proxy. Rimuovi tutte le impostazioni del tipo di autenticazione e l'accettazione dei criteri.

Requisiti di installazione

Il programma di installazione di Discovery Bot è integrato con il programma di installazione di Automation
360. Non è richiesta alcuna installazione separata per gli utenti Discovery Bot On-Premises. Questa attività
viene eseguita dall'amministratore IT dell'organizzazione. Consulta Installing Control Room On-Premises alla
pagina 838.

Nota:  Assicurati che i requisiti del server di database siano soddisfatti prima di utilizzare la modalità di
autenticazione SQL per la connessione alla Control Room: Installing Control Room using Custom mode alla
pagina 902.
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Per l'installazione personalizzata, è ora possibile modificare la posizione predefinita del percorso
dell'archivio in una nuova posizione sul server dopo l'installazione. The default path is: C:\ProgramData
\AutomationAnywhere\ServerFiles. The Process Discovery files now reside in the ServerFiles folder.

Nota:  Per admin Control Room. Se cambi il percorso predefinito nella nuova posizione, devi copiare e
incollare manualmente i dati esistenti nella nuova posizione.

Il file PDD generato per un'opportunità viene ora memorizzato localmente sul server da Automation 360
On-Premises. Il percorso di memorizzazione dei file è: C:\ProgramData\AutomationAnywhere
\ServerFiles\ProcessDiscovery\opportunity. I file PDD esistenti vengono automaticamente
spostati nella nuova posizione e non vengono eliminati quando viene eseguita una nuova installazione o un
aggiornamento nella Control Room.

Verifica dell'installazione

Al termine dell'installazione, accedi alla Control Room come amministratore. La scheda Discovery Bot è
disponibile per l'uso dal pannello sinistro.

package Process Discovery

Il package Process discovery contiene actions che registrano varie operazioni dell'oggetto, tra cui i clic
(destro o sinistro), la registrazione e il ridimensionamento della finestra, utilizzate durante le sessioni
di registrazione del processo. Visualizza le informazioni sul package Process Discovery nella pagina
Visualizza pacchetto (Bot >  Pacchetti >  Process Discovery).
Il package è incluso nei pacchetti predefiniti. È possibile precaricare il pacchetto predefinito quando
si effettua la connessione al dispositivo. Precaricare il pacchetto aiuta a ridurre il tempo di avvio del
registratore la prima volta che si avvia la registrazione di un processo.
Le actions nel package non sono disponibili per l'utilizzo da parte del Bot editor.
Concetti correlati
Preload packages alla pagina 2004
You can preload packages on your local device to shorten the bot runtime.

Upgrade Discovery Bot from Enterprise A2019.15 to later versions
Upgrade Discovery Bot from Enterprise A2019.15 (On-Premises) to a later version for the latest features
and enhancements.
Enterprise A2019.15 provides a separate installer (executable file) for Discovery Bot On-Premises users to
install and use Discovery Bot from the Control Room. Starting from A2019.16, the Discovery Bot installer is
integrated with the Enterprise A2019 installer. To upgrade from Enterprise A2019.15 to a later version, you
must first uninstall Discovery Bot from your machine and install the Control Room.
1. In your Windows device, go to Apps & features.
2. Search for Discovery Bot.
3. Click Uninstall.
4. Installa la versione più recente di Control Room.

Installing Control Room On-Premises alla pagina 838
5. From your local machine, log in to your Control Room as an administrator.

The Discovery Bot tab is available for use from the left panel.
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Creazione di utenti per Discovery Bot
Crea l'amministratore, l'analista e gli utenti Discovery Bot per iniziare a utilizzare la funzionalità Discovery
Bot per i processi aziendali di front-office e back-office. L'amministratore della Control Room crea questi
utenti e assegna i ruoli di sistema richiesti.
Assicurati di aver acquistato le licenze Discovery Bot necessarie per i tuoi utenti aziendali prima di iniziare a
creare degli utenti: Prerequisiti per Discovery Bot alla pagina 2335.
Per utilizzare le funzionalità Discovery Bot, all'utente devono essere assegnati il ruolo e le licenze
appropriati. Consulta Supported licenses for Discovery Bot alla pagina 2332.

Nota:  Il ruolo Admin e le autorizzazioni Discovery Bot sono diversi dal ruolo Admin Control Room.
Consulta Discovery Bot utenti alla pagina 2330.

1. Dal computer locale, accedi alla Control Room come amministratore .
2. Vai ad Amministrazione > Utenti.
3. Fai clic su Crea utente.

L'icona viene visualizzata nella parte superiore destra della tabella Utenti.
Viene visualizzata la pagina Crea utente.

4. Nella sezione Dettagli generali, inserisci i seguenti dettagli dell'utente:

Abilita utente Seleziona la casella di controllo in modo che
l'utente possa accedere immediatamente.

Nome utente Inserisci un nome utente univoco.
Descrizione Facoltativo: Inserisci una descrizione per l'utente.
Nome Facoltativo: Immetti il nome dell'utente.
Cognome Facoltativo: Inserisci il cognome dell'utente.
E-mail Inserisci e conferma l'indirizzo e-mail dell'utente.

Se il protocollo SMTP è abilitato, all'utente
viene inviata un'e-mail a questo indirizzo per
confermare l'account. Fai clic sull'URL nell'e-mail
per accedere alla Control Room e configurare
le credenziali. Tutte le notifiche importanti della
Control Room verranno inviate a questo indirizzo
e-mail.

5. Nella sezione Seleziona ruoli, seleziona uno dei seguenti ruoli dalla colonna Ruoli disponibili.
Utente Discovery Bot Seleziona questo ruolo

Amministratore AAE_Discovery Bot Admin

Analista AAE_Basic e AAE_Discovery Bot Analyst

Nota:  Il ruolo AAE_Basic è necessario per
visualizzare o aggiungere operazioni ai bot.

Utente aziendale AAE_Basic e AAE_Discovery Bot User

Nota:  Il ruolo AAE_Basic è necessario per
visualizzare o aggiungere operazioni ai bot creati
dall'analista.
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6. Fai clic sulla freccia destra per spostare il ruolo nella colonna Selezionati.
7. Nella sezione Assegna una licenza per dispositivo all'utente e seleziona quanto segue:

Utente Discovery Bot Azione

Amministratore Mantieni l'impostazione predefinita Nessuno per
l'utente.
Questo utente ha soltanto accesso a Control
Room.

Analista Assegna la licenza di sviluppo - Creatore di
bot a questo utente.

Nota:  Questa licenza è necessaria per convertire
un'opportunità in un bot.

Utente aziendale Mantieni l'impostazione predefinita Nessuno per
l'utente.
Questo utente ha soltanto accesso a Control
Room.

8. In Assegnare altri tipi di licenze per questo utente? > Licenze Discovery Bot, seleziona
quanto segue:
Utente Discovery Bot Azione

Amministratore Non è richiesta alcuna licenza.

Analista Seleziona la licenza Analizzatore di processi.

Utente aziendale Seleziona la licenza Registratore di processi.

9. Fai clic su Crea utente.
Il nuovo utente viene visualizzato nella tabella Utente. Se il protocollo SMTP è abilitato, al nuovo
utente creato verrà inviata un'e-mail di invito a effettuare l'accesso.

Create a Discovery Bot process alla pagina 2344
Puoi iniziare ad acquisire i processi aziendali utilizzando Discovery Bot. Crea un processo e assegna gli
utenti per registrare e acquisire il processo utilizzando il registratore Discovery Bot.

Create multi-role users for Discovery Bot
Create multi-role users when you want to combine system-generated Discovery Bot roles and licenses to
provide additional functionality for your users. Depending on your business requirements, you can combine
up to three Discovery Bot system-generated roles and two process discovery licenses.
Ensure that you have purchased the necessary Discovery Bot licenses for your business users: Prerequisiti
per Discovery Bot alla pagina 2335.
Per utilizzare le funzionalità Discovery Bot, all'utente devono essere assegnati il ruolo e le licenze
appropriati.

Nota:  Il ruolo Admin e le autorizzazioni Discovery Bot sono diversi dal ruolo Admin Control Room.
Consulta Discovery Bot utenti alla pagina 2330.

Multi-role users will see a different set of menu actions (vertical ellipsis icon) available on a tile for a
process. These actions are different from the standard Discovery Bot user actions that are available on a
tile for a process.
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The following actions are available for multi-role users (Admin + Business user + Analyst) on a tile for a
process:

Admin actions • Visualizza dettagli processo
• Modifica dettagli processo
• Elimina processo
• Visualizza/modifica dettagli processo

Business user actions • Avvia registrazione…
The Start Recording icon is displayed on a tile
for a process, or you can select start recording
from the vertical ellipsis icon.

• Modifica le mie registrazioni

Analyst action Analyze processes
Visualizza opportunità di processo

1. Dal computer locale, accedi alla Control Room come amministratore .
2. Vai ad Amministrazione > Utenti.
3. Fai clic su Crea utente.

L'icona viene visualizzata nella parte superiore destra della tabella Utenti.
Viene visualizzata la pagina Crea utente.

4. Nella sezione Dettagli generali, inserisci i seguenti dettagli dell'utente:

Abilita utente Seleziona la casella di controllo in modo che
l'utente possa accedere immediatamente.

Nome utente Inserisci un nome utente univoco.
Descrizione Facoltativo: Inserisci una descrizione per l'utente.
Nome Facoltativo: Immetti il nome dell'utente.
Cognome Facoltativo: Inserisci il cognome dell'utente.
Password Facoltativo: Enter your password and confirm the

password.
E-mail Inserisci e conferma l'indirizzo e-mail dell'utente.

Se il protocollo SMTP è abilitato, all'utente
viene inviata un'e-mail a questo indirizzo per
confermare l'account. Fai clic sull'URL nell'e-mail
per accedere alla Control Room e configurare
le credenziali. Tutte le notifiche importanti della
Control Room verranno inviate a questo indirizzo
e-mail.

5. In the Select Roles section, select the following roles from the Available roles column to create
multi-role users:
Utente Discovery Bot Seleziona questo ruolo

Admin + Business user AAE_Discovery Bot Admin and
AAE_Discovery Bot User

Admin + Analyst AAE_Basic, AAE_Discovery Bot Admin, and
AAE_Discovery Bot Analyst
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Utente Discovery Bot Seleziona questo ruolo

Business user + Analyst AAE_Basic, AAE_Discovery Bot User, and
AAE_Discovery Bot Analyst

Admin + Business user + Analyst AAE_Basic, AAE_Discovery Bot
Admin, AAE_Discovery Bot User, and
AAE_Discovery Bot Analyst

6. Click the right arrow to move the roles to the Selected column.
7. Nella sezione Assegna una licenza per dispositivo all'utente e seleziona quanto segue:

Utente Discovery Bot Azione

Admin + Business user Mantieni l'impostazione predefinita Nessuno per
l'utente.
Questo utente ha soltanto accesso a Control
Room.

Admin + Analyst Assegna la licenza di sviluppo - Creatore di
bot a questo utente.

Nota:  Questa licenza è necessaria per convertire
un'opportunità in un bot.

Business user + Analyst Assegna la licenza di sviluppo - Creatore di
bot a questo utente.

Nota:  Questa licenza è necessaria per convertire
un'opportunità in un bot.

Admin + Business user + Analyst Assegna la licenza di sviluppo - Creatore di
bot a questo utente.

Nota:  Questa licenza è necessaria per convertire
un'opportunità in un bot.

8. In the Allocate other types of licenses for this user section, select the following:
Utente Discovery Bot Azione

Admin + Business user Seleziona la licenza Registratore di processi.

Admin + Analyst Seleziona la licenza Analizzatore di processi.

Business user + Analyst Select the Process analyzer and Process
recorder licenses.

Admin + Business user + Analyst Select the Process analyzer and Process
recorder licenses.

9. Fai clic su Crea utente.
Il nuovo utente viene visualizzato nella tabella Utente. Se il protocollo SMTP è abilitato, al nuovo
utente creato verrà inviata un'e-mail di invito a effettuare l'accesso.

Create a Discovery Bot process alla pagina 2344
Log in with your multi-role credentials and create a process. Assign users to record and capture the
process using the Discovery Bot recorder. Review and analyze business processes.
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Create a custom role for Discovery Bot
Learn how to create a Discovery Bot custom role that allows users to select Discovery Bot feature
permissions from standard business user roles (Admin, Business user, or Analyst roles), and a single
Control Room admin feature permission for viewing users.
Ensure that you have purchased the necessary Discovery Bot licenses for your business users: Prerequisiti
per Discovery Bot alla pagina 2335.
Per utilizzare le funzionalità Discovery Bot, all'utente devono essere assegnati il ruolo e le licenze
appropriati.

Nota:  Il ruolo Admin e le autorizzazioni Discovery Bot sono diversi dal ruolo Admin Control Room.
Consulta Discovery Bot utenti alla pagina 2330.

Caso d'uso The Discovery Bot custom role user is enabled
with Control Room Admin feature permissions for
viewing users, but does not have edit permissions.
The role allows the user to view and manage all
Discovery Bot feature permissions for processes,
recordings, aggregations, and opportunities.
However, the role does not allow the user to view
opportunities or the associated metadata created
by other analysts in the Opportunities tab. The
permission to view all opportunities is not enabled
for the user.

1. Dal computer locale, accedi alla Control Room come amministratore .
2. Go to Administration > Roles.
3. Click Create role.

The icon is located at the top-right of the All roles table.
The Create role page is displayed.

4. Enter a Role name, and optionally enter a Role description.
5. Scroll to the Administration section.
6. Select View users.
7. Select View roles.
8. Scroll to the Discovery Bot section.
9. Select View assigned process at the parent level.

The child-level permissions are enabled.
10. Select all the following feature permissions: .

a) Discovery Bot process feature permissions at the child level
b) Discovery Bot recording feature permissions at the parent and child levels
c) Discovery Bot aggregation feature permissions at parent and child levels
d) Discovery Bot opportunity feature permissions at the parent and child levels

Nota:  Do not select View all opportunities.

11. Click Create role.
The Discovery Bot custom role is created.

Assign the Discovery Bot custom role to a user alla pagina 2343
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Assign the Discovery Bot custom role to a user
Create a new user and assign the Discovery Bot custom role you created to the user.
Ensure that you have purchased the necessary Discovery Bot licenses for your business users: Prerequisiti
per Discovery Bot alla pagina 2335.
Per utilizzare le funzionalità Discovery Bot, all'utente devono essere assegnati il ruolo e le licenze
appropriati.

Nota:  Il ruolo Admin e le autorizzazioni Discovery Bot sono diversi dal ruolo Admin Control Room.
Consulta Discovery Bot utenti alla pagina 2330.

Custom role users will see a different set of menu actions (vertical ellipsis icon) available on a tile for
a process, depending on the permissions given to users. These actions are different from the standard
Discovery Bot user actions that are available on a tile for a process.
For this custom role use case, the following actions are available on a tile for a process:

Admin actions • Visualizza dettagli processo
• Modifica dettagli processo
• Elimina processo

Business user actions • Avvia registrazione…
The Start Recording icon is displayed on a tile
for a process, or you can select start recording
from the vertical ellipsis icon.

• Modifica le mie registrazioni

Analyst action Analyze processes

1. Dal computer locale, accedi alla Control Room come amministratore .
2. Vai ad Amministrazione > Utenti.
3. Fai clic su Crea utente.

L'icona viene visualizzata nella parte superiore destra della tabella Utenti.
Viene visualizzata la pagina Crea utente.

4. Nella sezione Dettagli generali, inserisci i seguenti dettagli dell'utente:

Abilita utente Seleziona la casella di controllo in modo che
l'utente possa accedere immediatamente.

Nome utente Inserisci un nome utente univoco.
Descrizione Facoltativo: Inserisci una descrizione per l'utente.
Nome Facoltativo: Immetti il nome dell'utente.
Cognome Facoltativo: Inserisci il cognome dell'utente.
Password Facoltativo: Enter your password and confirm the

password.
E-mail Inserisci e conferma l'indirizzo e-mail dell'utente.

Se il protocollo SMTP è abilitato, all'utente
viene inviata un'e-mail a questo indirizzo per
confermare l'account. Fai clic sull'URL nell'e-mail
per accedere alla Control Room e configurare
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le credenziali. Tutte le notifiche importanti della
Control Room verranno inviate a questo indirizzo
e-mail.

5. In the Select Roles section, select the AAE_Basic role and the Discovery Bot custom role you
created from the Available roles column.

6. Click the right arrow to move the roles to the Selected column.
7. In the Allocate a device license to this user section, select the Bot Creator - Development

license.
8. In the Allocate other types of licenses for this user section, select the Process analyzer and

Process recorder licenses.
9. Fai clic su Crea utente.

Il nuovo utente viene visualizzato nella tabella Utente. Se il protocollo SMTP è abilitato, al nuovo
utente creato verrà inviata un'e-mail di invito a effettuare l'accesso.

Create a Discovery Bot process alla pagina 2344
Log in with your custom role credentials and create a process. Assign users to record and capture the
process using the Discovery Bot recorder. Review and analyze business processes.

Create a Discovery Bot process
Create a Discovery Bot process and assign users to record and analyze a process for your automation
requirements.
• This task is performed by the Discovery Bot admin who manages the creation, deletion, and editing of

Discovery Bot processes.

Nota:  L'utente di ruoli personalizzati e con più ruoli può anche eseguire questa attività a seconda dei
ruoli o delle autorizzazioni concesse agli utenti. Vedrai una diversa serie di azioni di menu (icona dei
puntini di sospensione in verticale) disponibili su un riquadro per un processo.

• Ensure the Process recorder license is allocated to Discovery Bot users assigned to recording a
process.

• Ensure the Process analyzer license is allocated to the Discovery Bot analyst assigned to analyzing a
process.
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• Create a process and assign users:
a) From your local machine, log in to your Control Room as a Discovery Bot administrator.
b) Vai a Discovery Bot > Processi.
c) Click Create Process.

The Create process page is displayed.
d) In the General Details tab, enter a Process Name .

Special characters are not supported. Creating a process with a duplicate name is not supported.
e) Opzionale: Enter a Process Description.
f) Click Next to assign users to a process.
g) Opzionale: In the Users tab, select the Discovery Bot business user or analyst from the list of

Available users.
h) Click the right arrow to move the roles to the list in the Selected column.
i) Click Next to view the invitation that is sent to users to begin recording processes.
j) Click Create Process.
k) Click Close to exit the page and return to the Processes page.

Nota:  An email invitation is sent to assigned users (new users or users added at a later time) to
begin a Discovery Bot process recording session.

The newly created process is displayed in the Processes page on a tile.
For users, all of their assigned processes are available for viewing from the Processes page.
Use the search field to help you locate a specific process by name. Questo campo non è sensibile
alla distinzione tra maiuscole/minuscole. For users, use the field to search on a process you are
assigned to. For admin users, use the field to search on all processes. Use the sort field to help
you locate a process tile quickly. Click the drop-down to sort for a process tile based on the process
name in alphabetical order or you can sort in the order of newest process created to oldest process
and vice versa. The tile for a process displays the following information for an admin user:

Process tile Descrizione

Registrazioni The number of the recordings captured
and stored for a process by users.

Ciclo processo The average time, in minutes and
seconds, across all recordings captured
for a process.
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Process tile Descrizione

Vertical ellipsis icon (three dots)

Nota:  You might see a different set of
menu actions available from the tile if
you are a Discovery Bot standard user,
multi-role user, or custom role user.

View, edit, or delete information for a
process.
• Click View process details to view

more information about a process,
edit and update information, and save
changes.

• Click Edit process details to edit a
process. Enter your changes and click
Save changes. Click Close to return
to the Processes page.

Nota:  The name of the process
cannot be changed.

• Click Delete process to delete a
process. A message window appears.

• Click Yes, delete to delete a process.
All recordings and associated data are
permanently deleted. This cannot be
undone.
Click No, cancel to return to the
Processes page.

• Click View/edit process details
to view more information about a
process, edit and update information,
and save changes. To edit a process,
click Edit. Enter your changes and
click Save changes. Click Close to
return to the Processes page.

Nota:  The name of the process
cannot be changed.

• Click Edit my recording to edit and
review recordings.

• Click View process opportunities
to view auto-generated or custom
opportunities created from the
Opportunities tab.
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• Create a process and add users at a later time:
a) From your local machine, log in to your Control Room as a Discovery Bot administrator.
b) Vai a Discovery Bot > Processi.
c) Click Create Process.

The Create process page is displayed.
d) In the General Details tab, enter a Process Name.

Special characters are not supported. Creating a process with a name previously used for another
process is not supported.

e) Opzionale: Enter a Process Description.
f) Click Create Process to create a process without assigning users.
g) Click Close to exit the page and return to the Processes page.

• Update an existing process and add users.
a) From your local machine, log in to your Control Room as a Discovery Bot administrator.
b) Vai a Discovery Bot > Processi.
c) Go to the process you want to edit.
d) Click Edit from the Options icon.
e) In the Edit process page, click Next to assign users to a process.
f) In the Users tab, select the Discovery Bot business user or analyst from the list of Available

users.
g) Click the right arrow to move the roles to the list in the Selected column.
h) Fai clic su Salva modifiche.
i) Click Next to view the invitation that is sent to users to begin recording processes.
j) Click Close to exit the page and return to the Processes page.

Nota:  An email invitation is sent to assigned users (new users or users added at a later time) to
begin a Discovery Bot process recording session.

The newly created process is displayed in the Processes page on a tile.

Registrare un processo aziendale Discovery Bot alla pagina 2348
Log in to your Control Room as a Discovery Bot user and record a business process assigned to you.

Supported applications and browsers for Discovery Bot
Learn about supported applications and browsers to ensure your environment is ready before you begin
using the Discovery Bot recorder.

About the Discovery Bot recorder

The Discovery Bot recorder is similar in function to the Automation 360 Universal Recorder with one
significant difference: pre-selection of the application to be used for recording is not required.
The Discovery Bot recorder captures data across many user interface (UI) objects such as Windows
applications, native applications, executable file, or browser window on PC devices and machines or virtual
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machines running Windows OS. Use the Discovery Bot recorder to capture, read (data extraction), write
(data entry), and click (left or right) operations when working across various operations. A single recording
per user can capture up to 8 hours of user actions.
The Discovery Bot recorder displays the performed action by using highlighter. Fai clic sul controllo
dell'oggetto, ad esempio un pulsante, un campo del modulo o una tabella. Un contorno rosso evidenzia il
controllo quando sposti il mouse sopra di esso per acquisire l'azione.
Puoi eseguire azioni come doppio clic, trascinamento, mantenimento del clic e selezione del testo durante
la registrazione. Le azioni eseguite con i tasti di scelta rapida vengono visualizzate nel campo Dati.

Supported applications and browsers

The recorder supports system, web, and virtual applications including the following:

Applicazioni • Microsoft applications: Edge, PowerPoint, Excel,
Word, Outlook, Calculator, Notepad, Notepad++,
Teams

• Zoom
• Snagit
• Java applet, web start, and desktop applications

that run using Java Runtime Environment
(JRE) 6, 7, 8, 9, 10, and 11 (32-bit and 64-bit
versions)

• Microsoft Active Accessibility and UI automation
based applications

• Oracle EBS and Forms
• SAP 730, 740, 750 and 760 versions.
• Citrix Virtual Apps

Browser • Internet Explorer versione 11
• Google Chrome

Nota:  Chrome plug-in must be installed to
record processes. If the Chrome plug-in is
removed, you must manually add and re-enable
the plug-in. Google Chrome browser extension
requirements alla pagina 1959

Desktop The desktop refers to the device screen when all
application and browser windows are minimized.

Barra dei comandi The taskbar is the horizontal or vertical bar
containing icons of open applications and browsers,
as well as the notification area. You can capture
application, browser, system, and other icons, for
example such as the clock and calendar, volume,
and Wi-Fi.

Registrare un processo aziendale Discovery Bot
Registra, acquisisci e annota i passaggi di un processo aziendale utilizzando il registratore Discovery Bot.
La registrazione del processo consente all'analista Discovery Bot di visualizzare tutti passaggi registrati per
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un'analisi quantitativa e comparativa. I passaggi, insieme ai metadati acquisiti e alle azioni utente, aiutano
l'analista a prendere la decisione di creare opportunità e bots.
• Questa attività viene eseguita dall'utente Discovery Bot che registra i processi aziendali assegnati e li

invia per la revisione e l'analisi.

Nota:  L'utente di ruoli personalizzati e con più ruoli può anche eseguire questa attività a seconda dei
ruoli o delle autorizzazioni concesse agli utenti. Vedrai una diversa serie di azioni di menu (icona dei
puntini di sospensione in verticale) disponibili su un riquadro per un processo.

• Assicurati di aver impostato le credenziali del dispositivo e di aver installato la versione Bot Agent più
recente sul computer prima di utilizzare il registratore Discovery Bot.

• Assicurati che anche il computer su cui si eseguiranno le registrazioni sia debitamente registrata.
Prerequisiti per Discovery Bot alla pagina 2335

1. Registra un processo aziendale:
a) Dal computer locale, accedi alla tua Control Room come utente aziendale Discovery Bot.
b) Vai a Discovery Bot > Processi.

Compare la pagina Processi, che mostra tutti i processi assegnati all'utente per la registrazione.
c) Fai clic sull'icona Avvia registrazione dal riquadro associato al processo che desideri iniziare a

registrare.

Nota:  Puoi selezionare Avvia registrazione anche dall'icona dei puntini di sospensione verticali
per avviare la registrazione di un processo.

Appare una finestra del messaggio che notifica che ora stai registrando e condividendo il tuo
schermo. Compare la finestra Registratore Discovery Bot con le opzioni Pausa e Sospendi.
Metti in pausa e riprendi la registrazione in base alle esigenze. Attendi alcuni minuti per consentire
al registratore di avviarsi la prima volta che si inizia a registrare un processo.

d) Esegui le azioni da registrare.
Ad esempio, apri un'applicazione e compila un modulo oppure apri un browser e cerca un
sito web. Fai clic sul controllo dell'oggetto, ad esempio un pulsante, un campo del modulo o
una tabella. Un contorno rosso evidenzia il controllo quando sposti il mouse sopra di esso per
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acquisire l'azione. Il contorno rosso indica che il registratore è pronto per l'azione successiva nella
registrazione del processo.
Puoi eseguire azioni come doppio clic, trascinamento, mantenimento del clic e selezione del testo
durante la registrazione. Le azioni eseguite con i tasti di scelta rapida vengono visualizzate nel
campo Dati.

e) Fai clic su Sospendi per terminare la registrazione.
Puoi fare clic su Annulla registrazione per annullare una registrazione in qualsiasi momento.
Attendi alcuni secondi che il registratore termini. I dettagli nel riquadro per il processo vengono
incrementati e includono la nuova registrazione nella sezione Registrazioni.

Nota:  Una volta sospesa la registrazione, non si possono aggiungere ulteriori passaggi alla
registrazione.

Nota:  È possibile acquisire un massimo di 8 ore di azioni utente in una singola registrazione.

f) Immetti un nome per la registrazione nel campo fornito.
Il limite di caratteri è 50. I caratteri speciali sono supportati.

g) Fai clic su Salva per salvare le modifiche.
h) Fai clic su Annulla per scartare la registrazione.

Nota:  Se scarti la registrazione, non puoi recuperarla.

2. Esamina i passaggi acquisiti, annotali e invia una registrazione del processo per la revisione all'analista
Discovery Bot:
a) Da Processi, seleziona un processo facendo clic sul nome del processo o in un punto qualsiasi

del corpo del riquadro del processo. From Processes, click the vertical ellipsis icon and select
Edit my recording to edit and review recordings.
Se fai clic sul corpo del riquadro del processo o sul nome del processo, compare la pagina
Opportunità. Solo le registrazioni approvate dalla scheda Opportunità vengono mostrate
all'analista.
Per gli utenti con più ruoli e ruoli personalizzati Discovery Bot, fai clic sull'icona dei puntini di
sospensione verticali e seleziona Modifica le mie registrazioni per modificare ed esaminare
le registrazioni. Se fai clic sul corpo del riquadro del processo o sul nome del processo, compare
la pagina Visualizza processo. Nella pagina Visualizza processo vengono mostrate solo le
registrazioni approvate per l'analista.
Compare la pagina Registrazioni con la tabella Registrazioni a sinistra e i dettagli della singola
registrazione a destra. La tabella mostra le seguenti informazioni:

Registrazioni Descrizione

Registrazioni (#) (# selezionate) Il numero di registrazioni collegate dagli
utenti.

Personalizza colonne Fai clic sull'icona della tabella per
visualizzare o nascondere le colonne
(ID, Stato, Ciclo di processo e
Registratore) o modificare il layout delle
righe di intestazione per visualizzarle a
destra o a sinistra come richiesto.
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Registrazioni Descrizione

ID Il numero ID della registrazione
nel database. Il sistema raccoglie e
incrementa in sequenza l'indice per ogni
registrazione acquisita dagli utenti.

Nota:  Per cercare una registrazione
specifica, seleziona ID e immetti il
numero ID nella barra di ricerca.

Nome Il nome della registrazione.

Stato Lo stato della registrazione:
• In sospeso: stato iniziale.
• Approvato: tutte le modifiche

richieste dall'utente sono state
completate e la registrazione è
pronta per la revisione da parte di
un analista.

• Errore: si è verificato un errore
durante la memorizzazione della
registrazione nel sistema.

• Rifiutato: attualmente non è in uso.

Nota:  Per cercare lo stato di un
processo, seleziona Stato e scegli uno
stato dall'elenco a discesa.

Ciclo processo La durata della registrazione, in minuti
e secondi, escluso il tempo di pausa del
registratore.

Registratore Il nome dell'utente che ha creato la
registrazione.

Nota:  Per cercare gli utenti assegnati
a una registrazione, seleziona
Registratore dall'elenco a discesa
e inserisci il nome utente nella barra
di ricerca. La ricerca fa distinzione tra
maiuscole e minuscole.

3. Nella tabella Registrazioni, seleziona l'ID per visualizzare tutti i passaggi acquisiti. Nel riquadro a
destra, l'intestazione mostra i dettagli dell'ID della registrazione, compresi i passaggi totali acquisiti
durante la sessione di registrazione, il nome della registrazione, il tempo del processo e lo stato attuale
della registrazione.
Ogni passaggio registrato include: immagine dello screenshot con l'opzione Schermo (icona), tipo
di applicazione, dati (testo inserito dalla tastiera) e campi di descrizione della fase (testo annotato
dall'utente).
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4. Facoltativo: per fornire una descrizione della registrazione, fai clic nell'area Descrizione. Usando il
campo Descrizione che appare, condividi il contesto e lo scopo della registrazione con l'analista.
Il limite di caratteri è 255. La descrizione inserita viene visualizzata anche nel PDD.

5. Fai clic su Salva per salvare la descrizione inserita nel campo Descrizione.
6. Facoltativo: fai clic sull'icona Schermo per visualizzare o nascondere l'immagine dello screenshot.

Utilizza l'icona dell'opzione Schermo quando non desideri condividere i dettagli dell'immagine
personale con l'analista Discovery Bot, gli utenti con più ruoli o ruoli personalizzati. Per rimuovere le
informazioni personali, ad esempio le credenziali di nome utente e password dall'immagine, modifica il
campo Dati prima dell'invio per la revisione da parte dell'analista.

Nota:  Se nascondi un'immagine e fai clic su Invia, non puoi visualizzare nuovamente l'immagine.

7. Fai clic sullo screenshot per visualizzare l'immagine in formato intero.
Screenshot mostra lo stato dell'applicazione al momento dell'esecuzione dell'azione associata. Il
contorno rosso evidenzia il punto in cui hai eseguito azioni come mantenimento del clic e selezione
del testo.Non puoi modificare lo screenshot. Fai clic sull'immagine quando vuoi visualizzare una vista
più grande dello screenshot. Esamina l'azione del passaggio in modo più dettagliato dalla finestra
modale. Fai clic sull'impaginazione situata sotto l'immagine per selezionare un numero di fase o
utilizza le frecce destra o sinistra per visualizzare rapidamente tutte le immagini acquisite. Per le azioni
non acquisite dal registratore, come il doppio clic, il trascinamento e il mantenimento del clic, puoi
documentare i singoli passaggi nel campo Descrizione passaggio per l'analista.
La durata del passaggio registrato viene visualizzata in minuti e secondi sotto la schermata. Utilizza
queste informazioni per stabilire con maggiore facilità la priorità di quale passaggio o sequenza di
passaggi sia un candidato migliore per l'automazione. Ad esempio, se una sequenza di passaggi
richiede più tempo per l'esecuzione, puoi automatizzare prima questo processo per risparmiare sforzi
manuali.
• Fai clic sull'icona Nascondi immagine per nascondere l'immagine.

L'immagine non verrà inviata all'analista per la revisione. Fai clic sulla X per chiudere il frame. Fai
clic su Salva per salvare la selezione.

• Fai clic su Mostra immagine per visualizzare l'immagine.
L'immagine verrà inviata all'analista per la revisione. Fai clic sulla X per chiudere il frame. Fai clic su
Salva per salvare la selezione.

8. Opzionale: Aggiorna il nome dell'applicazione utilizzato nella registrazione del processo nel campo di
testo Applicazione.
Il campo Applicazione rappresenta il nome dell'applicazione su cui è stata eseguita l'azione. Se
necessario, l'utente che ha effettuato la registrazione può modificarla.

9. Opzionale: Nel campo di testo Dati, aggiorna il testo inserito dalla tastiera utilizzato nella registrazione
del processo.
Il campo Dati rappresenta tutti i dati inseriti dall'utente in quel passaggio durante la registrazione.

Nota:  È necessario seguire l'inserimento dei dati della tastiera facendo clic con il pulsante sinistro o
destro del mouse. Per qualsiasi passaggio in cui i dati sono stati inseriti, puoi apportare modifiche ai
dati nel campo Dati. Non puoi inserire i dati per i passaggi che non hanno dati immessi durante la
registrazione effettiva del processo.

10. Opzionale: Aggiorna il contesto associato al passaggio nel campo di testo Descrizione passaggio.
Il campo di testo Descrizione passaggio rappresenta qualsiasi descrizione aggiuntiva desideri
fornire in merito all'operazione in corso. Il limite massimo di caratteri è 2000.

11. Facoltativo: elimina qualsiasi passaggio che non è necessario includere nella registrazione del
processo.

12. Ripeti i passaggi precedenti per ciascun passaggio, come richiesto.
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13. Opzionale: Fai clic su Salva per salvare le modifiche.
Utilizza l'opzione Salva quando desideri modificare e confrontare i dati di registrazione (inclusi
applicazione, testo immesso dalla tastiera e campi di testo per le annotazioni) in più registrazioni
acquisite nella tabella Registrazioni.

14. Facoltativo: fai clic su Elimina per eliminare la registrazione di quel processo.
Usa il tasto Elimina quando non vuoi sottoporre i dati di registrazione all'analista per la revisione.
La registrazione e i dati associati vengono eliminati dalla cartella Registrazioni di quel processo.

15. Fai clic su Invia.
La registrazione viene inviata all'analista per la revisione e l'approvazione.

Nota:  Dopo che una registrazione è stata inviata, non può essere modificata ulteriormente.

16. Fai clic sull'opzione Scarica per esportare i dati dell'opportunità in un Process Definition Document
(PDD) con lo stesso nome dell'opportunità. Seleziona il tipo di PDD (Word o PDF) che vuoi esportare.
Il PDD include un diagramma di flusso della registrazione dei processi e la durata di ogni singolo
passaggio in ore, minuti e secondi.
Quando viene creata un'opportunità, il PDD inizia automaticamente l'elaborazione in background.
Quando il PDD viene generato, il campo cambia da Elaborazione PDD in corso a Scarica. Ora è
possibile scaricare il documento. Viene anche inviata una notifica via e-mail all'utente aziendale
all'indirizzo e-mail in archivio. Se si verifica un errore quando si scarica il PDD, fai nuovamente clic su
Scarica per generare di nuovo il PDD.

Nota:  Se sei un utente multiruolo, riceverai due notifiche e-mail per i dati esportati, una per i dati di
registrazione e una per i dati di opportunità.

Nota:  Devi essere il proprietario dell'opportunità per poterla scaricare, altrimenti l'opzione di
download non è disponibile.

Sul tuo computer, il documento viene salvato nella cartella configurata per il download nel tuo browser.

Analisi delle opportunità di automazione alla pagina 2354
Accedi alla Control Room come analista Discovery Bot per esaminare e analizzare le registrazioni e creare
opportunità o bots, come richiesto.

Registrazione di processi Discovery Bot con AARI Assistant
Utilizza AARI Assistant per registrare i processi aziendali Discovery Bot senza accedere alla Control Room.
• Prima di utilizzare il registratore Discovery Bot, assicurati di aver impostato le credenziali del dispositivo

e di aver installato l'ultima versione di Bot Agent sul tuo computer.

Nota:  L'installazione di Bot Agent caricherà l'icona AARI sul desktop.

• Assicurati che anche il computer su cui si eseguiranno le registrazioni sia debitamente registrata.
Prerequisiti per Discovery Bot alla pagina 2335

• Assicurati che le impostazioni del browser permettano i reindirizzamenti e i pop-up dal browser per
accedere alla Control Room.

1. Fai doppio clic sull'icona AARI per aprire AARI Assistant.
2. Utilizza le credenziali Automation 360 per accedere all'applicazione.
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3. Fai clic su Processi.
Appare la pagina Processi di registrazione, che visualizza tutti i processi assegnati e disponibili per
l'utente.

4. Quando vuoi iniziare a registrare un processo, fai clic su Avvia registrazione.
Appare una finestra del messaggio che notifica che ora stai registrando e condividendo il tuo schermo.
Compare la finestra Registratore Discovery Bot con le opzioni Pausa e Sospendi. Metti in pausa
e riprendi la registrazione in base alle esigenze. La prima volta che inizi a registrare un processo, il
registratore potrebbe impiegare alcuni minuti per iniziare a registrare.

5. Esegui le azioni da registrare.
6. Per terminare la registrazione, fai clic su Stop.

You will be redirected to the Control Room to review and edit your recording before you submit it.
Registrare un processo aziendale Discovery Bot alla pagina 2348

7. Per rivedere i passaggi delle registrazioni precedenti e inviarle, fai clic su Registrazioni precedenti.
Sarai reindirizzato alla Control Room per rivedere le registrazioni.

Analisi delle opportunità di automazione
Esamina le opportunità e i dati di registrazione dei processi utilizzando grafici e tabelle che ti aiutano ad
analizzare e comprendere i benefici e i risparmi di una potenziale opportunità con o senza automazione.

Opportunità

L'intestazione Opportunità fornisce un'istantanea della registrazione e dei dati di opportunità acquisiti da
tutti gli utenti per i processi assegnati. Nell'intestazione Opportunità vengono mostrati i seguenti dati:

Campo Descrizione

Risparmi Risparmi potenziali (risparmio annuo o risparmio
per esecuzione) associati all'opportunità

Numero di opportunità Numero di opportunità che includono le
registrazioni selezionate

Numero varianti di processo Numero di ramificazioni incluse nell'opportunità

Ciclo processo medio Durata media delle registrazioni fornite per il
processo

Partecipanti Numero di utenti che hanno presentato
registrazioni per il processo

Evoluzione delle opportunità

Utilizza la mappa dell'evoluzione delle opportunità per scegliere quali opportunità automatizzare per prime.
Ogni quadrante mostra quanto segue:
• Procedi ora: Queste opportunità offrono il massimo beneficio e la massima facilità di implementazione.
• A lungo termine: Queste opportunità danno un buon ROI ma richiedono tempo per essere

implementate. Richiedono anche un maggiore sforzo di implementazione per l'automazione.
• In attesa: Il beneficio dell'automazione è basso e il tempo di implementazione è alto. Il consiglio è di

non automatizzare.
• Successi rapidi: Scegli sempre questo per primo per acquisire slancio.
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Utilizzo applicazione

Il grafico a ciambella mostra il numero di applicazioni utilizzate nelle registrazioni selezionate. I dettagli
di utilizzo dell'applicazione vengono mostrati nella tabella a destra del grafico nel seguente formato:
applicazione | minuti secondi | percentuale. La percentuale rappresenta la percentuale delle applicazioni
utilizzate sul totale di tutte le applicazioni utilizzate.

Caso d'uso

Utilizza queste informazioni per comprendere rapidamente la partecipazione degli utenti, nonché la
complessità e la variabilità del processo; maggiore è il conteggio delle applicazioni, maggiori sono la
complessità e la variabilità del processo analizzato. Il tempo medio del ciclo del processo fornirà una breve
panoramica della durata del processo entro il tempo di elaborazione previsto. Se il ciclo del processo
effettivo è più elevato nel conteggio delle applicazioni, questo potrebbe indicare che il processo è un
candidato più adatto per l'automazione con conseguente miglioramento dell'efficienza.

Durata ciclo di processo per processo

Questo grafico mostra il tempo associato al ciclo medio del processo (in minuti) per ogni processo e
utente.

Caso d'uso

Utilizza queste informazioni per capire quali processi richiedono più tempo e quindi, se automatizzati,
offriranno potenzialmente più risparmi. Ad esempio, un analista può scoprire perché la registrazione
di un processo ha richiesto più tempo o è stata completata in un periodo più breve per un particolare
partecipante e confrontare queste informazioni con quelle relative ad altri partecipanti. Queste informazioni
sono fondamentali per restringere un sottoinsieme più piccolo delle registrazioni per studiarle allo scopo di
individuare inefficienze che potrebbero comportare migliori o maggiori opportunità di automazione.

Numero di passaggi di un processo

Questo grafico mostra il numero medio di passaggi manuali in ogni processo e per utente. Usa queste
informazioni per confrontare il numero di passaggi nei vari processi. I processi con un numero maggiore di
passaggi manuali sono i migliori candidati per l'automazione.

Esame delle opportunità, conversione in bot e creazione di PDD
Esamina potenziali opportunità generate dal sistema, crea opportunità personalizzate da un'opportunità
generata dal sistema e convertile in bots. Puoi anche esportare i dati delle opportunità in un documento
Microsoft Word o PDF a titolo di riferimento.
Le opportunità di automazione sono di due tipi, generate dal sistema e manuali. Le opportunità generate
dal sistema, note anche come opportunità generate automaticamente, vengono create quando per un
processo almeno una registrazione viene approvata dall'utente. Le opportunità generate automaticamente
sono immediatamente disponibili per l'analisi da parte dell'utente nella pagina Opportunità per la
registrazione. L'opzione Scarica per creare un documento Microsoft Word o PDF non è disponibile per le
opportunità generate automaticamente. La creazione di un ramo e la fusione dei passaggi nel ramo per le
opportunità generate automaticamente non è disponibile dal diagramma del processo.
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Le opportunità manuali, conosciute anche come opportunità personalizzate, sono create da opportunità
generate automaticamente. Un'opportunità personalizzata offre la flessibilità di rivedere le registrazioni
attuali e quelle appena aggiunte dagli utenti e di decidere di accettare o rifiutare le nuove modifiche di
registrazione al diagramma del processo esistente. È inoltre possibile creare un ramo quando al diagramma
del processo si aggiungono passaggi da un'altra registrazione. L'opzione Scarica è disponibile se vuoi
scaricare un documento Microsoft Word o PDF dei dati di opportunità personalizzati a titolo di riferimento
personale.
• Questa attività viene eseguita dall'analista Discovery Bot responsabile della revisione e dell'analisi delle

registrazioni associate dei processi aziendali.
• Ensure the analyst is assigned a Process analyzer license and the AAE_Discovery Bot Analyst role

before processes are analyzed.
Supported licenses for Discovery Bot alla pagina 2332

• Assicurati che all'analista sia assegnata una licenza Bot Creator per convertire le opportunità in bots.
Supported licenses for Discovery Bot alla pagina 2332

1. Esamina i dati nella scheda Opportunità:
a) Dal computer locale, accedi a Control Room come analista Discovery Bot.
b) Vai a Discovery Bot > Opportunità.

La pagina Opportunità mostra tutte le opportunità create. È possibile configurare l'opzione di
menu da visualizzare come si desidera utilizzando l'icona Personalizza colonne. La tabella
elenca le seguenti informazioni:

Campo Descrizione

Nome opportunità Nome creato per l'opportunità. Per
identificare un'opportunità generata
automaticamente da un'opportunità
personalizzata, l'opportunità generata
automaticamente inizia con il nome del
processo trattino OPPORTUNITÀ.

Nome processo Nome creato per il processo.

Tipo Tipo di opportunità creata per un
processo. Il tipo può essere Automatica
o Personalizzata.

Percorso Tipo di percorso specificato in
base all'opzione Filtro applicato
all'opportunità. Le opportunità generate
automaticamente usano il valore
predefinito del filtro del percorso più
comune.

Data di creazione Quando è stata creata l'opportunità.

Data modifica Data in cui l'opportunità viene
modificata dall'analista. Può esserci una
data di modifica quando un'opportunità
viene aggiornata o quando viene creata
un'opportunità personalizzata.

Proprietario Nome del proprietario del processo. Il
proprietario del processo può essere un
sistema o un analista.
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Campo Descrizione

N. di registrazioni Numero di registrazioni per un processo
associato all'opportunità.

N. di applicazioni Numero di applicazioni utilizzate in
una sessione di registrazione associata
all'opportunità.

Ciclo processo Durata della sessione di registrazione
associata all'opportunità.

N. di utenti Numero di utenti che hanno partecipato
alla sessione di registrazione per quel
processo.

Costo senza automazione Formula utilizzata per calcolare il costo
dell'opportunità senza automazione.
Utilizza la formula per decidere a
quali opportunità dare la priorità per
lo sviluppo aziendale in base al ROI,
alle applicazioni utilizzate, al numero
di utenti e così via. La formula è
calcolata prendendo il numero di utenti
moltiplicato per la paga oraria totale di
questi moltiplicato per il ciclo medio del
processo.

Risparmi Potenziali risparmi associati
all'opportunità (è possibile indicarli
come risparmi annuali o per ciclo).

Priorità Livello di priorità assegnato
all'opportunità. Il livello di priorità può
essere uno dei seguenti:
• Basso
• Medio
• Alto

Bot creato Bot creato per un'opportunità. Questo
può essere Sì o No. L'opzione Converti
in bot non è disponibile per le
opportunità generate automaticamente.
The Convert to bot option is available
for custom opportunities only.

c) Seleziona l'opportunità richiesta ordinando oppure cercando la tabella, o eseguendo entrambe le
azioni, utilizzando il campo Cerca.

d) Fai clic sull'icona dell'ellissi verticale (tre punti) dalla tabella per visualizzare un'opportunità o
scaricare un documento PDD in Word o PDF.
L'opzione di scarico del PDD in Word o PDF è disponibile solo per le opportunità personalizzate.

e) Seleziona un'opportunità dalla tabella per la visualizzazione.
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2. Opzionale: Crea un'opportunità personalizzata dall'opportunità generata automaticamente.
a) Espandi la sezione Registrazioni dal lato sinistro della tela principale.

Per impostazione predefinita, tutte le registrazioni selezionate sono visualizzate nel diagramma del
processo.

b) Seleziona una singola registrazione dalla sezione Registrazioni per rivederla, se necessario.
La registrazione selezionata appare in blu dalla sezione Registrazioni e viene visualizzata nella
nuova tela di alimentazione a sinistra della tela principale. Tutte le registrazioni sono visualizzate
nel diagramma del processo a destra della tela principale. Disattiva la registrazione selezionata per
selezionare un'altra registrazione da visualizzare.

c) Seleziona l'icona dello screenshot o l'icona dell'applicazione per decidere come visualizzare i
passaggi.
Utilizza le opzioni Zoom avanti o Zoom indietro in base alle esigenze. Utilizza Reimposta lo
zoom per riportare la visualizzazione al livello predefinito e centrare nuovamente il processo nella
tela.
I passaggi contigui eseguiti nella stessa applicazione vengono combinati insieme. Ciò viene
visualizzato come un singolo gruppo per consentire una migliore leggibilità del processo. Il
numero di passaggi riuniti insieme è indicato nell'angolo in basso a destra del gruppo.

Nota:  Se la visualizzazione dello screenshot è l'ultima attiva, l'immagine dell'ultimo passaggio nel
gruppo è quella visualizzata per il gruppo compresso. È possibile trascinare il processo all'interno
della tela tenendo premuto il pulsante sinistro del mouse e spostando il processo nella posizione
desiderata.

d) Fai clic su un passaggio per espandere un gruppo di passaggi e visualizzare un'anteprima del
passaggio in modo più dettagliato. In alternativa, fai clic sulla freccia vicino all'angolo in alto a
destra dell'icona del gruppo.
Usa l'icona del gruppo per visualizzare i gruppi di passaggi appartenenti alle azioni di livello
principale e secondario (e alle azioni di livello sottogruppo) utilizzate durante la sessione di
registrazione. Se necessario, espandi un gruppo di passaggi per fare il drill down dalle azioni
principali a quelle del sottogruppo per decidere quale gruppo di passaggi usare per la creazione di
una potenziale opportunità per un'attività che vuoi automatizzare. Ad esempio, un'azione a livello
principale visualizza Microsoft Outlook, un'azione a livello secondario visualizza la notifica della
posta di Outlook mentre le azioni a livello sottogruppo visualizzano componi e-mail, corpo e-mail e
invia e-mail.

e) Seleziona la casella di controllo Seleziona tutti i passaggi dal pannello Panoramica per
selezionare tutti i passaggi nel diagramma del processo.
In base alle tue esigenze, usa il tasto MAIUSC per personalizzare il numero di passaggi all'interno
di un percorso dalla tela principale. Se selezioni una ramo o un loop nidificati, il ramo o il loop
padre mostra una selezione parziale.

f) Opzionale: Usa l'opzione Filtro per personalizzare un'opportunità specifica. Using the Filter and
Toggle frequency counter options alla pagina 2361.

g) Opzionale: Utilizza l'opzione Alterna contatore di frequenza per visualizzare la frequenza del
percorso rispetto alle altre registrazioni. Per ulteriori informazioni, consulta Using the Filter and
Toggle frequency counter options alla pagina 2361.

h) Fai clic su Salva con nome per salvare l'opportunità come opportunità personalizzata.
i) Inserisci un nome e una descrizione dell'opportunità nei campi forniti.
j) Fai clic su Salva con nome per salvare le modifiche.

Si apre una finestra di messaggio che notifica che l'opportunità è stata creata. Fai clic sul
collegamento ipertestuale per visualizzare l'opportunità personalizzata. Il PDD è generato e
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disponibile per essere scaricato dalla tabella Opportunità. Fai clic sui puntini di sospensione
verticali per scaricare il PDD in formato Word o PDF.

Nota:  L'opzione filtro che hai selezionato per un'opportunità personalizzata non si rifletterà nel
nuovo diagramma del processo dell'opportunità personalizzata.

3. Opzionale: Crea un'altra opportunità personalizzata da un'opportunità personalizzata. Aggiungi
passaggi da un'altra registrazione al diagramma del processo, crea un ramo e unisci passaggi da una o
più registrazioni nel ramo.
a) Seleziona una singola registrazione dalla sezione Registrazioni.
b) Fai clic sull'icona del ramo dalla tela principale a destra per aggiungere un passaggio di

condizione.
Sposta il passaggio successivo in un ramo a sinistra e aggiungi un nuovo ramo a destra nel ramo
vuoto che deve ricevere i passaggi da un'altra registrazione. Nell'angolo in alto a destra della
casella gialla, fai clic sui tre puntini per creare un nuovo ramo o eliminarne uno. L'endpoint del
ramo viene visualizzato con un piccolo cerchio.
Per impostazione predefinita, puoi spostare l'endpoint del ramo più in basso nel flusso del
percorso per includere più di un passaggio. Per spostare l'endpoint del ramo, premi con il cursore
sull'endpoint fin quando non verranno visualizzate le linee tratteggiate intorno ai rami. Trascina
l'endpoint verso il basso nel flusso del percorso. Posiziona il punto finale quando vengono
mostrate le linee tratteggiate tra la freccia. L'endpoint viene spostato verso il basso nel flusso del
percorso e include più passaggi. Per selezionare una serie personalizzata di passaggi, utilizza il
tasto MAIUSC per selezionare un determinato numero di passaggi all'interno di un percorso dalla
tela principale. La selezione del percorso incrociato non è disponibile.
L'icona del loop viene visualizzata come un cerchio arancione con una freccia. Un loop è
una sequenza di passaggi che si verifica per un numero specifico di volte per una singola
registrazione. Sotto l'icona del loop compare la condizione for insieme a un Conteggio, che
descrive il numero di volte in cui la sequenza di passaggi in questo loop viene ripetuta nel
processo. Puoi cambiare la condizione del loop (for e while) salvando il diagramma del processo.

c) Fai clic sul campo Condizione a livello di nodo.
d) Nel campo Condizione, immetti un nome per la condizione. Esempio: punteggio di

 affidabilità creditizia.
e) Fai clic sul segno di spunta per salvare il nome della condizione.
f) Apri i rispettivi rami a destra e a sinistra e imposta un valore per la condizione.

Ad esempio, immetti meno di 200 a destra e più di 700 a sinistra.
g) Trascina e rilascia i passaggi dalla registrazione nell'area della tela di alimentazione al passaggio

del ricevitore che riporta Trascina qui gli elementi del ramo nell'area della tela principale.
Utilizza il tasto MAIUSC per selezionare uno o più passaggi da trascinare nel passaggio di
destinazione. Per cancellare una condizione nel ramo, fai clic sui tre puntini. Seleziona Cancella
ramo.

h) Fai clic su Salva per salvare le modifiche al diagramma del processo.
Il PDD inizia l'elaborazione in background automaticamente. Quando il PDD viene generato, il
campo cambia da Elaborazione PDD in corso a Scarica.

i) Ripeti i passi da a ad h per rivedere altre registrazioni e creare rami e unire i passaggi nel ramo.
j) Dal pannello Panoramica, fai clic sull'icona Modifica per aggiornare i potenziali risparmi

associati all'opportunità personalizzata.
I risparmi potenziali e i costi potenziali possono essere aggiornati in qualsiasi momento, man
mano che si rivedono i passi delle varie registrazioni e si apportano cambiamenti all'interno del
diagramma di processo.
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k) Immetti il costo stimato del processo senza automazione.
l) Immetti il risparmio potenziale associato al processo quando si usa l'automazione.

Questa è la tua migliore valutazione dei risparmi previsti su base annuale nel caso in cui un bot
venga utilizzato per eseguire tutti i passaggi dell'opportunità.

m) Seleziona la priorità dall'elenco a discesa.
n) Fai clic su Aggiorna.
o) Fai clic su Salva per salvare le modifiche al diagramma del processo.
p) Ripetere i passi da j a o per aggiornare il costo potenziale dell'opportunità personalizzata dal

pannello Panoramica.
q) Fai clic su Salva con nome per salvare l'opportunità come opportunità personalizzata.
r) Inserisci un nome e una descrizione dell'opportunità nei campi forniti.
s) Fai clic su Salva con nome per salvare le modifiche.

Si apre una finestra di messaggio che notifica che l'opportunità è stata creata. Fai clic sul
collegamento ipertestuale per visualizzare l'opportunità personalizzata.

t) Opzionale: Ripeti i passaggi da 4a a s per creare un'altra opportunità personalizzata da questa
opportunità personalizzata, se necessario.
Tutte le opportunità (autogenerate e personalizzate) possono essere visualizzate nella pagina
Opportunità.

4. Opzionale: Per le opportunità personalizzate, esamina le nuove registrazioni inviate dall'utente
Discovery Bot. Accetta o rifiuta le nuove modifiche per il diagramma del processo.
a) Fai clic su Esamina per accettare gli aggiornamenti ed esaminare le nuove registrazioni.
b) Seleziona la nuova registrazione dalla sezione Registrazioni.

La registrazione selezionata è evidenziata in blu. La registrazione si apre per la visualizzazione
a sinistra della tela. Fai riferimento alle linee tratteggiate intorno ai passaggi. Il posizionamento
dei passaggi viene visualizzato nel diagramma del processo a destra della tela con un bordo in
grassetto intorno ai passaggi. The shaded green refers to the placement of the groups of steps
from the new recording as they will appear in the process diagram if you update with these
changes.

c) Fai clic su Aggiorna con le modifiche per accettare gli aggiornamenti al diagramma del
processo.
Viene visualizzato un messaggio pop-up che indica che le modifiche sono state aggiornate con
successo.

d) Fai clic su Indietro per modificare per tornare al diagramma del processo corrente senza le
modifiche.

e) Fai clic su Ignora per ignorare le modifiche.
Continua a esaminare l'attuale diagramma del processo per l'opportunità personalizzata. Aggiungi
passaggi da un'altra registrazione al diagramma del processo, crea un ramo e unisci passaggi da
una o più registrazioni nel ramo, secondo necessità.
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5. Converti in bot:
a) Fai clic sull'opzione Converti in bot.
b) Immetti un nome bot.
c) Opzionale: Immetti una descrizione.
d) Fai clic su Sfoglia e accetta la posizione predefinita della cartella \Bots\.

Per modificare la posizione in cui è memorizzato il bot, esegui il drill-down fino alla cartella in cui
desideri salvare il bot.

e) Fai clic su Conferma.
f) Fai clic su Converti.

Compare una finestra di messaggio che notifica che la conversione del bot è iniziata. Riceverai
un'e-mail quando il bot sarà stato convertito correttamente. Fai clic sul collegamento ipertestuale
nell'e-mail per accedere alla cartella in cui è stato creato il bot.

Nota:  Nella scheda I miei bot, il bot convertito mostra un errore, con una dimensione di 0
byte mentre la creazione del bot è in corso. Evita di aprire il bot fino al completamento della
conversione del bot stesso.

L'opzione Converti in bot è disponibile solo se si dispone della licenza Bot Creator. Per esaminare il
bot creato, è necessario che all'utente sia stato assegnato il ruolo AAE_Basic.

6. Fai clic sull'opzione Scarica per esportare i dati dell'opportunità in un Process Definition Document
(PDD) con lo stesso nome dell'opportunità. Seleziona il tipo di PDD (Word o PDF) che vuoi esportare.
Il PDD include un diagramma di flusso della registrazione dei processi con un collegamento URL al
diagramma del processo all'interno di Discovery Bot e la durata di ogni singolo passaggio in ore, minuti
e secondi. The PDD does not display the process diagram if there are more than 100 steps selected.
Quando viene creata un'opportunità, il PDD inizia automaticamente l'elaborazione in background.
Quando il PDD viene generato, il campo cambia da Elaborazione PDD in corso a Scarica. Ora è
possibile scaricare il documento. Viene anche inviata una notifica via e-mail all'utente aziendale
all'indirizzo e-mail in archivio. Se si verifica un errore quando si scarica il PDD, fai nuovamente clic su
Scarica per generare di nuovo il PDD.

Nota:  Se sei un utente multiruolo, riceverai due notifiche e-mail per i dati esportati, una per i dati di
registrazione e una per i dati di opportunità.

Nota:  Devi essere il proprietario dell'opportunità per poterla scaricare, altrimenti l'opzione di
download non è disponibile.

Sul tuo computer, il documento viene salvato nella cartella configurata per il download nel tuo browser.

Using the Filter and Toggle frequency counter options
Use the Filter and Toggle frequency counter options from the toolbar to help you review, analyze, and
compare the various recordings in the process work flow as you look to create a potential opportunity.

Filter option

Use the Filter option when you want to use a set of values to compare the different sections of a process
across various recordings by selecting a specific path and step filter. The Filter window displays the
following:
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Opzione Azione

Path: Con il flusso più comune Select this option when you want to see what
paths have the most common variance of a
process that is being used. If you choose to
automate this type of path, you will have a
higher return on your investment.

Path: Con il maggior numero di deviazioni Select this option when you want to see certain
sections of the process that have a different
deviation in the path. The automation priority for
such paths are usually low.

Path: Con il flusso più ripetitivo Select this option when you want to display
sections of the process that are more repetitive
and cost more. The automation priority for such
paths are usually high.

Step: Applicazione Select the Application option when you
want to see the application type used during
the recording. Use this option to see which
applications are more frequently used, and to
decide on which applications should be a priority.

Step: Tipo azione Select the Action type option to filter the
process steps to display only particular actions
that will help you get an idea how the steps are
used.

Cancella Select Clear to clear all selected options.

Ripristina Select Reset to reset to the previous saved state
of the filters in a view.

Applica Select Apply to apply the selected options for
display for the system generated or manual
opportunity.

Attiva/disattiva contatore frequenza

Use the toggle frequency counter option to display the number of recordings that a particular path takes
in the flow for a system generated or manual opportunity. Use this option to help you understand the
frequency of the path as compared to other recordings. From the Recordings table, select two or more
recordings and the Toggle frequency counter displays two at the start of the process flow to indicate
the number of recordings selected. If each recording takes a different path, the process flow is divided
between the total number of recordings selected and displays accordingly. For example, if there are ten
recordings in a view and three paths displayed. Two recordings follow one path, two recordings follow the
second path, and six recordings follow the third path. Along the path flow, you will see two, two, and six.
If a step is merged, the number gets added between the two paths. Use the thick or thinness of the path
to help you prioritize processes for automation. The most commonly used path is the thickest path and this
can be useful for prioritizing a process when reviewing many recordings. For example, if there are 5 paths
for 20 recordings, you will quickly see which is the thickest and consider automating this path. If you have
additional bandwidth to automate another path, you can drill down in the flow and look at the numbers to
see what path is next as a possible candidate for automation.
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Messaggi di errore di pre-elaborazione
Se si verificano errori di pre-elaborazione, esaminare la causa ed eseguire l'azione richiesta per risolvere
l'errore.
If you build a bot that has more than 2000 lines of code, and if descendant actions like Loop > Continue
or Break actions are used in the bot, it can cause pre-processing errors. To prevent such pre-processing
failures, we recommend that you break the larger bot into smaller bots, and use the Task Bot > Run
action to run from any other bot.

Nota:
• From Automation 360 v.23, if an error occurs when you run a bot, a preprocessing or runtime error

is shown. Note that preprocessing of child bots does not occur in sequence because these bots are
referred in the parent bot and are sometimes in complex nested workflows. Therefore, the errors might
be displayed in any sequence for these child bots. The parent bot cannot proceed further until all the
errors in the child bots are resolved.

• The following scenarios are applicable only to Automation 360 v.21 or earlier releases. For v.22, Only
the Catch action scenario is applicable, so review the probable cause.

Causa Azione richiesta

A mismatch occurred and we did not find the
expected variable data type.

Utilizzare un'espressione in linea o un'azione
separata per convertire al tipo di dati variabile
corretto.
Variables overview alla pagina 2022

Un valore "$" viene letto come variabile, ma non
esiste alcuna variabile di questo tipo.

Utilizzare "$$" per evitare il simbolo del dollaro e
riprovare.

The bot is calling another bot, but we did not
find the child bot at the specified location.

Verificare che il percorso sia corretto e riprovare.

Rilevata un'azione Catch non contenuta in
un'azione Try.

Assicurarsi che ogni azione Catch sia contenuta
in un'azione Try.

Rilevata un'azione Try che non contiene
un'azione Catch. Ogni azione Try richiede almeno
un'azione Catch al suo interno.

Assicurarsi che ogni azione Try contenga
un'azione Catch.

Build advanced bots and packages
Learn how to build action packages and advanced bots that include custom features such as scripting, and
API calls. Find recommendations on bot and action package design and reusability.

More resources

On the Developer portal, find additional how-to tutorials on building advanced bots and packages.
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Pacchetto SDK
Il pacchetto SDK consente di creare e caricare pacchetti di azioni sulla tua Control Room.
Il kit di sviluppo pacchetti Automation Anywhere fornisce istruzioni dettagliate per gli utenti per sviluppare
in modo indipendente azioni personalizzate e caricare e gestire pacchetti nella loro Control Room. Le azioni
personalizzate vengono costruite in un IDE e compilate per generare file Java Archive (JAR). I file JAR
vengono quindi caricati nella Control Room e diventano disponibili come azioni nel Pannello delle azioni.

La sezione Pacchetto SDK include il codice di esempio e i file di supporto per gli sviluppatori Java per
creare e convalidare azioni personalizzate.

November 2022, Release (Automation 360 v.27) A360-package-sdk-2.6.1.zip

June 2022, Release (Automation 360 v.25) A360-package-sdk-2.5.0.zip

December 2021, Release (Automation 360 v.23) A360-package-sdk-2.4.1.zip

September 2021, Release (Automation 360 v.22) A360-package-sdk-2.3.0.zip

June 2021, Release (Automation 360 v.21) A2019-package-sdk-2.1.0.zip

April 2021, Release (A2019.20) A2019-package-sdk-2.0.9.zip

February 2021, Release (A2019.19) A2019-package-sdk-2.0.8.zip

January 2021, Release (A2019.18) A2019-package-sdk-2.0.7.zip

November 2020, Release (A2019.17) A2019-package-sdk-2.0.6.zip

September 2020, Release (A2019.16) A2019-package-sdk-2.0.5.zip

August 2020, Release (A2019.15) A2019-package-sdk-2.0.4.zip

July 2020, Release (A2019.14) A2019-package-sdk-2.0.3.zip

May 2020, Release (A2019.13) A2019-package-sdk-2.0.2.zip

April 2020, Release (2019.12.1) A2019-package-sdk-2.0.1.zip
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April 2020, Release (2019.12) A2019-package-sdk-2.0.0.zip

March 2020, Release (2019.11) A2019-package-sdk-1.0.11.zip

February 2020, Release (A2019.10) A2019.10-package-sdk-1.0.0.zip

January 2020, Release (A2019.09) • Pacchetto demo SDK: A2019.09-
packageSDK-1.0.0.zip

• Documentazione: A2019.09-package-annotations-
javadoc.zip

November 2019 Release (A2019.08) • Pacchetto demo SDK: A2019.08-
packageSDK-1.0.0.zip

• Documentazione: A2019.08-package-annotqations-
javadoc.zip

October 2019 Release (A2019.07) • Pacchetto demo SDK: A2019.07-Package-
Sdk-1.0.0.zip

• Documentazione: A2019.07-package-annotations-
javadoc.zip

Per le note sulla versione dettagliate per i pacchetti SDK, consulta Automation 360 Package SDK Release
Notes alla pagina 709.
Fai clic su un titolo per leggere i dettagli di ciascuna attività del processo.

Set up the Java project alla pagina 2366 Set up an integrated development environment
(IDE) for Java, including Automation Anywhere
custom annotations to develop an action package
that you can upload to your Control Room.

Standard coding practices and guidelines for developing
packages alla pagina 2367

This topic covers standard coding practices and
guidelines that help to ensure the development of
high quality packages.

Develop a sample package alla pagina 2369 Develop your own package and upload it to an
Control Room to provide custom actions for bots.

How to examples alla pagina 2375 This section contains code examples and
explanations about how to code some basic bot
capabilities.

Annotations alla pagina 2412 This section provides reference information
about the annotations used to create Automation
Anywhere packages.

Build and test a demo package and bot alla pagina
2417

This practical how to section demonstrates that
creating, changing, and managing packages allow
you to customize actions and efficiently manage
packages for all Control Room users.

Build and test a custom package alla pagina 2423 Utilizza IntelliJ per creare un pacchetto
personalizzato e utilizza le azioni Automation 360
per testare il pacchetto.

Riferimenti correlati
Automation 360 Package SDK Release Notes alla pagina 709
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https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019.07-package-sdk-1.0.0.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019.07-package-annotations-javadoc.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019.07-package-annotations-javadoc.zip


    Automation Anywhere - Crea

Review the new, changed, fixed, and deprecated features, and security fixes, known issues, and limitations
for the Automation 360 (formerly Enterprise A2019) Package SDK.

Set up the Java project
Set up an integrated development environment (IDE) for Java, including Automation Anywhere custom
annotations to develop an action package that you can upload to your Control Room.
A working knowledge of Java and Gradle is required in order to successfully build an action package. You
require the following software and file:
• Java Developer Kit (JDK) 11
• Java IDE

• Eclipse
• Community edition of IntelliJ

• Gradle plug-in v.5.*.* in the IDE
• Automation Anywhere Bot Agent installed and connected to your Control Room Download and

extract a zip file
Download and extract the zip file for the release you want:

November 2022, Release (Automation 360 v.27) A360-package-sdk-2.6.1.zip

June 2022, Release (Automation 360 v.25) A360-package-sdk-2.5.0.zip

December 2021, Release (Automation 360 v.23) A360-package-sdk-2.4.1.zip

September 2021, Release (Automation 360 v.22) A360-package-sdk-2.3.0.zip

June 2021, Release (Automation 360 v.21) A2019-package-sdk-2.1.0.zip

April 2021, Release (A2019.20) A2019-package-sdk-2.0.9.zip

February 2021, Release (A2019.19) A2019-package-sdk-2.0.8.zip

January 2021, Release (A2019.18) A2019-package-sdk-2.0.7.zip

November 2020, Release (A2019.17) A2019-package-sdk-2.0.6.zip

September 2020, Release (A2019.16) A2019-package-sdk-2.0.5.zip

August 2020, Release (A2019.15) A2019-package-sdk-2.0.4.zip

July 2020, Release (A2019.14) A2019-package-sdk-2.0.3.zip

May 2020, Release (A2019.13) A2019-package-sdk-2.0.2.zip

April 2020, Release (2019.12.1) A2019-package-sdk-2.0.1.zip

April 2020, Release (2019.12) A2019-package-sdk-2.0.0.zip

March 2020, Release (2019.11) A2019-package-sdk-1.0.11.zip

February 2020, Release (A2019.10) A2019.10-package-sdk-1.0.0.zip

January 2020, Release (A2019.09) • Pacchetto demo SDK: A2019.09-
packageSDK-1.0.0.zip

• Documentazione: A2019.09-package-
annotations-javadoc.zip

© 2023 Automation Anywhere. All rights reserved.     2366

https://www.eclipse.org/
https://www.jetbrains.com/idea/download/#section=windows
https://aa2019packagesdkfordocumentation.s3.us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A360-package-sdk-2.6.1.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A360-package-sdk-2.5.0.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A360-package-sdk-2.4.1.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A360-package-sdk-2.3.0.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019-package-sdk-2.1.0.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019-package-sdk-2.0.9.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019-package-sdk-2.0.8.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019-package-sdk-2.0.7.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019-package-sdk-2.0.6.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019-package-sdk-2.0.5.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019-package-sdk-2.0.4.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019-package-sdk-2.0.3.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019-package-sdk-2.0.2.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019-package-sdk-2.0.1.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019-package-sdk-2.0.0.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019-package-sdk-1.0.11.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019.10-package-sdk-1.0.0.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019.09-package-sdk-1.0.0.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019.09-package-sdk-1.0.0.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019.09-package-annotations-javadoc.zip
https://aa2019packagesdkfordocumentation.s3-us-west-2.amazonaws.com/aa2019packagesdkfordocumentation/A2019.09-package-annotations-javadoc.zip
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November 2019 Release (A2019.08) • Pacchetto demo SDK: A2019.08-
packageSDK-1.0.0.zip

• Documentazione: A2019.08-package-
annotqations-javadoc.zip

October 2019 Release (A2019.07) • Pacchetto demo SDK: A2019.07-Package-
Sdk-1.0.0.zip

• Documentazione: A2019.07-package-annotations-
javadoc.zip

Configure the build files, compile the JAR file, add the package to your Control Room, and then build a bot
to test your package. Build and test a demo package and bot alla pagina 2417.
Concetti correlati
Standard coding practices and guidelines for developing packages alla pagina 2367
This topic covers standard coding practices and guidelines that help to ensure the development of high
quality packages.
How to examples alla pagina 2375
This section contains code examples and explanations about how to code some basic bot capabilities.
Annotations alla pagina 2412
This section provides reference information about the annotations used to create Automation Anywhere
packages.
Build and test a demo package and bot alla pagina 2417
This practical how to section demonstrates that creating, changing, and managing packages allow you to
customize actions and efficiently manage packages for all Control Room users.
Attività correlate
Develop a sample package alla pagina 2369
Develop your own package and upload it to an Control Room to provide custom actions for bots.

Standard coding practices and guidelines for developing packages
This topic covers standard coding practices and guidelines that help to ensure the development of high
quality packages.

Testing Ensure high quality code. Write sufficient unit tests
and integration tests for your package.

Icons Set proper icon for your package.
Setting the version manually The SDK package build version gets updated

automatically every time a build happens. However,
you can set it manually in the command project of a
common build.gradle file.
• Update the build.gradle file before a build.
• Enter up to four digits numbers, separated my a

period, as shown below:

. . .
ext {
    version '2.0.8'
}
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dependencies {...}

Dipendenze Embed all the dependencies in your package JAR.
Load the dependencies at run time by extracting
them to a temporary location. Be sure to clean
the temporary location after the dependencies are
loaded.

Dependent JAR files Add dependent JAR files under dependencies in the
build.gradle file as implementation so that the
dependant JAR files are packaged.

 
. . .
dependencies {
  compileOnly name: 'command-
annotations'
  compileOnly name: 'bot-runtime'
  compileOnly name: 'bot-api'
  implementation name: 'i18n-api'
              implementation name:
 'mydependentjavafile.jar'
  apt name: 'command-processor'
  compileOnly group:
 'org.apache.logging.log4j',
 name: 'log4j-core', version:
 "$loggerVersion"
  testImplementation
 "org.testng:testng:$testNgVersion"
  testImplementation name: 'bot-
runtime'
  testImplementation name: 'bot-api'
 }
. . . 

Add new actions to the exiting package When adding new actions to an existing package,
make sure to do clean before packaging. It
is always a good practice to do clean build -
gradlew.bat clean build shadowJar.

Messaggi di errore Provide meaningful error messages.
• Do throw meaningful error messages.

For example, in local language using i18n
APIs with BotCommandException,
throw a new exception
BotCommandException(MESSAGES.getString("Run.Exception.InvalidWorkingDirPath")).

• Do not throw generic error messages, such as
ex.message.

Basic validation Use the validation annotation rules, such as
@NotEmpty included with this development kit. Do
not add basic validations for your code. Consulta
Validation annotations alla pagina 2415.

Loops Avoid long running loops in your code. Long
running loops can cause high CPU usage, leading to
errors such as, "Bot is unresponsive."
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Add logging Use the default log4J logger provided in the bot
run time framework. Do not add your own logger.
See the sample code for details.

Logging levels • ERROR/FATAL: Severe error event that the
user is affected and there is no workaround.

• WARN : Unexpected error occurred but the
system has recovered from it.

• INFO: Informational messages about state
change, for example, an accepted request.

• DEBUG: Detailed diagnostic information that
will be required to debug when something goes
wrong.

• TRACE: All information is captured about an
application behavior.
If you are not sure of the log level, set it to
TRACE.

Loading resources All resources should be loaded using current thread
context class loader, as shown in the following
example:

Thread.currentThread().getContextClassLoader().getResourceAsStream("resource.json");

Concetti correlati
How to examples alla pagina 2375
This section contains code examples and explanations about how to code some basic bot capabilities.
Annotations alla pagina 2412
This section provides reference information about the annotations used to create Automation Anywhere
packages.
Attività correlate
Set up the Java project alla pagina 2366
Set up an integrated development environment (IDE) for Java, including Automation Anywhere custom
annotations to develop an action package that you can upload to your Control Room.
Develop a sample package alla pagina 2369
Develop your own package and upload it to an Control Room to provide custom actions for bots.

Develop a sample package
Develop your own package and upload it to an Control Room to provide custom actions for bots.
Download and extract the contents from the latest Automation 360 Package SDK release. The newest
package contains the necessary sample source code to build your package.
You need to have a project created in a Java IDE. For details about setting up a project, read Set up the
Java project alla pagina 2366.
The following high-level tasks provide the basic workflow for creating a package.
1. Create a java class.

This class is the action you plan to publish in your package.

Importante:  It is required that the class supports the default constructor.

© 2023 Automation Anywhere. All rights reserved.     2369



    Automation Anywhere - Crea

2. Add required business logic to the class.
The following are the supported return types:
• Void: Use this return type if your action does not return any value.
• Valore: Use this return type if your action returns any type of value.

3. Annotate the class with BotCommand and CommandPkg Annotations to make the class eligible to be
converted to an action.

4. Annotate the variable that accepts values with Idx and Pkg.
5. Annotate the entry method with the Execute annotation.
6. From the action prompt, run gradlew.bat clean build shadowJar.

The JAR file created from the build is located in build/lib.

From the Control Room on the Bots > Package page, click the Add package icon to upload the JAR file.

Suggerimento:  To upload a package to a Control Room, you need Upload package permission. Review
how to add a package to an Control Room: Add packages to the Control Room alla pagina 2649.

Concetti correlati
Standard coding practices and guidelines for developing packages alla pagina 2367
This topic covers standard coding practices and guidelines that help to ensure the development of high
quality packages.
How to examples alla pagina 2375
This section contains code examples and explanations about how to code some basic bot capabilities.
Annotations alla pagina 2412
This section provides reference information about the annotations used to create Automation Anywhere
packages.
Attività correlate
Set up the Java project alla pagina 2366
Set up an integrated development environment (IDE) for Java, including Automation Anywhere custom
annotations to develop an action package that you can upload to your Control Room.

Using the package SDK
These example topics provide a basic understanding of how to use the Package SDK with Automation 360.
Each SDK package includes a collection of configurable files that you can use to build a custom package,
and then use the package to create TaskBots.
Use the following steps to create, configure, and build an IntelliJ project to compile a new package, and
then create a bot to test the package you created.
1. Download, extract, and review the Package SDK files:

• Download the latest Automation Anywhere A2019 Package SDK.
Enterprise Automation360 Package Development Kit Release Notes

• Go to your Downloads folder, right-click your downloaded Package SDK, and select Extract All.
• Review all the files included in the package. You can drop any java file in your IntelliJ project to

view or edit the content.
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2. Install the latest Automation 360 version:
a) After the installation, log in to the Control Room with an admin privilege and create a new user

with permissions to upload a package and create bots.
Create a user alla pagina 2684

b) Connect your local device to the Control Room. If required, download and install the latest Bot
Agent.
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039

3. Install Java SE Development Kit 11 or IntelliJ IDE Community Edition and Gradle plug-in.
• Java SE Development Kit 11 (https://www.oracle.com/java/technologies/javase/jdk11-archive-

downloads.html)
• Java IDE (https://www.jetbrains.com/idea/download/#section=windows)

4. Configure the sample build files in the IntelliJ project.
Configuring build files alla pagina 2371

5. Create a new directory, package, and class.
Creating new Java class alla pagina 2372

6. Use the compiled JAR file as a package and upload it to your Control Room in Automation 360.
Upload custom package to your Control Room alla pagina 2374

7. Create a TaskBot to test the new package.
Create a bot to test the new package alla pagina 2374

8. Opzionale: Verify the results, and if required, add additional actions to your bot flow, and configure
parameters and values.

9. View additional resources.
To learn more, search for the Package SDK: How to examples.

Configuring build files alla pagina 2371

Configuring build files
Use IntelliJ to configure and compile a JAR file, and then upload it as a package to your Control Room in
Automation 360.
A basic understanding of JDK and Java IntelliJ is required in order to build an action package. Ensure you
have the following software and files:
• Java SE Development Kit 11 (https://www.oracle.com/java/technologies/javase/jdk11-archive-downloads.html)
• Java IDE (https://www.jetbrains.com/idea/download/#section=windows)
• Automation Anywhere A2019 SDK. Download and extract the zip file for the release you require:

Enterprise A2019 Package Development Kit Release Notes

1. Unzip the contents of the SDK package to your IdeaProjects directory and rename the folder from
<latest package sdk zip file> to A2019FileDetails.

2. In IntelliJ IDEA, go to File > Open and open the project located at C:\Users\<User>
\IdeaProjects\A2019FileDetails.

3. Open the settings.gradle file in the project root, and set the rootProject.name =
 'A2019FileDetails'

4. Update the package.template file located at src > main > resources > package.template.
5. Change the package name from A2019DemoPackage to A2019FileDetails.
6. Update the package name in locales json: go to src > main > resources > locales >

en_US.json.
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a) Open the en_US.json file and update the required label field. Update the optional
description.

b) Delete all other remaining lines in the en_US.json file.

7. Open the build.gradle in the project root. After the dependencies section, remove other
dependencies, if they are not required.

8. Save all files.

Creating new Java class alla pagina 2372

Creating new Java class
Use IntelliJ to create a new java class and a new directory, and configure other build files.
Complete the steps in the following task: Configuring build files alla pagina 2371.
1. Create a new Java Class, right-click the com.automationanywhere.botcommand package, and

select New > Java Class. Enter the name for the new class GetFileDetails.
a) Copy @BotCommand from the Concatenate. java and paste it into the new

GetFileDetails.java file.

import static com.automationanywhere.commandsdk.model.DataType.STRING;
//BotCommand makes a class eligible for being considered as an action.

@BotCommand
//CommandPks adds required information to be dispalable on GUI.
@CommandPkg(
  //Unique name inside a package and label to display.
  name = "concatenate", label = "[[Concatenate.label]]", 
  node_label = "[[Concatenate.node_label]]", description =
 "[[Concatenate.description]]", icon = "pkg.svg", 
  
  //Return type information. return_type ensures only the right kind
 of variable is provided on the UI. 
  return_label = "[[Concatenate.return_label]]", return_type = STRING,
 return_required = true)
public class Concatenate {
 
 //Messages read from full qualified property file name and provide
 i18n capability.
 private static final Messages MESSAGES = MessagesFactory
   .getMessages("com.automationanywhere.botcommand.samples.messages");

 //Identify the entry point for the action. Returns a Value<String>
 because the return type is String. 
 @Execute
 public Value<String> action(
   //Idx 1 would be displayed first, with a text box for entering the
 value.
   @Idx(index = "1", type = TEXT) 
   //UI labels.
   @Pkg(label = "[[Concatenate.firstString.label]]") 
   //Ensure that a validation error is thrown when the value is null.
   @NotEmpty 
   String firstString,
   
   @Idx(index = "2", type = TEXT) 
   @Pkg(label = "[[Concatenate.secondString.label]]") 
   @NotEmpty 
   String secondString) {
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  //Internal validation, to disallow empty strings. No null check
 needed as we have NotEmpty on firstString.
  if ("".equals(firstString.trim()))
   throw new
 BotCommandException(MESSAGES.getString("emptyInputString",
 "firstString"));

  if ("".equals(secondString.trim()))
   throw new
 BotCommandException(MESSAGES.getString("emptyInputString",
 "secondString"));

  //Business logic
  String result = firstString + secondString;
  
  //Return StringValue.
  return new StringValue(result);

b) Update the @CommandPkg parameters such as: name, label, node_label, description,
and icon.

c) Update the return_label and the return_type.
d) Add the NumberValue action, internal validation, business logic, and the return value.
e) Delete the Concatenated. java file and samples.commands. basic directory, and the

sample.commands directory.

2. Configure the en_US.json file: go to src > main > resources > locales > en_US.json and add
the following fields after the label and description values, and delete other parameters from the file.

{
 "label": "File Details",
 "description": "Returns basic file details",
 "GetFileDetails.label": "File Size",
 "GetFileDetails.description": "Return the size of the selected file in
 bytes",
 "GetFileDetails.node_label": "File Size in Bytes",
 "GetFileDetails.return_label": "File Size",
 "GetFileDetails.return_label_description": "Return in bytes",
 "GetFileDetails.filePath.label": "Select a File for analysis"
}

3. Delete packages: go to src > main > java > com.automationanyhwere.botcommand, and
delete the samples.commands and delete the samples packages.

4. Import new icons from Github and update the CommandPkg annotation.
a) Download any icons you want to use in your bot flow and save them as .svg files.
b) Copy your image files into the src > main > resources > icons folder.

5. Create a new directory: go to src, right- click, and select New > Directory.
a) In the Name field, enter test\java. Alternatively, select the test\java, and enter the name

TestFileSize.
b) Configure test annotations in the TestFileSize java class.
c) Create a @test public class, create a GetFileDetails object, and invoke the action.
d) Opzionale: Run the TestGetFileDetails in IntelliJ to test it.
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6. Configure the TestFileSize file, and open TestFileSize and copy and paste the following code:

{
    @Test
    public void TestGetFileDetails() {
        String filePath = "src\\main\\resources\\icons\\sample.svg";
        //Create GetFileDetails Object
        GetFileDetails getFileDetails = new GetFileDetails();
        //invoke action
        NumberValue output = getFileDetails.action(filePath);
        Assert.assertEquals(output.getAsDouble(), 5027.0);
    }

7. Save the project: File > Save All.
8. Click Reload All Gradle Projects, and then click Execute Gradle Task, and verify that the

A2019FileDetails project is selected.
9. In the Run Anything window, enter gradle clean build shadowJar.

After it runs, the following message is displayed: BUILD SUCCESSFUL in 8s <number of seconds>

Upload custom package to your Control Room alla pagina 2374

Upload custom package to your Control Room
Use the compiled JAR file and upload it as a package to your Control Room in Automation 360.
• Complete the steps in the following task: Creating new Java class alla pagina 2372.
• Ensure you have the following:

• Access to the Control Room.
• Credentials with AAE_Basic permission or a custom role with the capability to upload packages to

the Control Room.

1. From Windows Explorer, go to C:\Users\<Username>\IdeaProjects\A2019-FileDetails
\build\libs and locate A2019FileDetails-2.0.9.jar.

2. Log in to your Control Room as a user with permissions to add a new package.
3. Click BOTS > Packages.
4. In the All packages page, move your mouse over the plus sign and click Add package.
5. In the Add package page, click Browse and locate the A2019FileDetails-2.0.9.jar file.

By default, the file is located at: C:\Users\<Username>\IdeaProjects\A2019-FileDetails
\build\libs.

6. Select the A2019FileDetails-2.0.9.jar file and click Open.
7. Click Upload Package.

When you upload a custom package to the Control Room, a notification is also sent to the Control
Room users to notify about package updates. This notification is sent to the users who have the
View package permission. For more information, see Add or update package alla pagina 2925 event
notification.

Create a bot to test the new package alla pagina 2374

Create a bot to test the new package
Use the actions in Automation 360 to create a bot and test the new package you have added to your
Control Room.

© 2023 Automation Anywhere. All rights reserved.     2374



    Automation Anywhere - Crea

Ensure you have the following to build the bot:
• Access to the Control Room.
• Credentials with AAE_Basic permission or a custom role to create bots.
• Your workstation is a registered device in the Control Room.
• Your package A2019FileDetails-2.0.9.jar is available in the Control Room.

1. Accedi a Control Room.
2. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
3. Click the Create a bot icon.
4. In the Name field, enter TestingFileSize or any other name you want.
5. Click Create & Edit.
6. In the Actions pane, find File Details and drag File Size into the bot flow.

a) In the Select a File for analysis field, select Desktop file, click Browse, and select any file
from your desktop.

b) Click Create variable to create a new number variable.
c) In Create Variable, enter nFileSize and click Create & Select.
d) Fai clic su Applica.

7. In the Actions pane, find the Number package and drag the To String command.
a) In the Enter a number field, enter F2, and select nFileSize.
b) In the Assign the output to variable field, select prompt-assignment - String from the

drop-down list.
c) Fai clic su Applica.

8. From the Actions pane, drag Message box.
9. In the Enter the message to display field, click F2 and select the prompt-assignment variable.
10. Click Apply and Save.
11. Fai clic su Esegui.

The bot displays the <The value of the file size> , which is a successful build.

If you were not able to run botyour bot, go back and modify your configuration steps in your Control
Room.

How to examples
This section contains code examples and explanations about how to code some basic bot capabilities.

Return a value from an action alla pagina 2377 Set the following properties on CommandPkg to
store the action output in a variable.

Expose property attributes of action alla pagina
2378

The property values of an action can be exposed by
setting the following properties on CommandPkg.

Organize and group actions when developing packages
alla pagina 2379

Review the provided examples on how to add and
group actions during the package SDK development
process.
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Input types - UI elements alla pagina 2380 The user interface (UI) elements are the input
controls used to receive inputs in an action while
building a bot.

Create custom variables using Package SDK alla
pagina 2382

When using Automation 360, you can create
custom variables using the SDK package.

Create a condition using Package SDK alla pagina
2387

When using Automation 360, you can create a
condition with the SDK package.

Add a condition in a custom package for If condition
alla pagina 2389

Add conditions in a custom package.

Create an iterator using Package SDK alla pagina
2390

In Automation 360, you can create an iterator
with the SDK package. An iterator is used to loop
through multiple objects of similar type and is used
with the Loop package. It consists of two methods,
next and hasNext, which return the actual object
and a boolean value.

Create a trigger using Package SDK alla pagina
2393

When using Automation 360, you can create a
trigger using the SDK package.

Custom triggers - pull and push mechanism alla
pagina 2396

The examples provided in this topic demonstrate
how to create time-based and event-based
triggers, pull (link TriggerDemo) and push
(SimpleMessageListenerContainer)
mechanisms using the SDK package.

Add debug logs of custom packages to bot_launcher.log
file alla pagina 2401

You can add logs using log4j. The dependency
is already added in the package SDK sample
build.gradle file.

Handle sessions in a custom package alla pagina
2402

You can extract a session using a session name
from the SessionsMap. In the same package, you
can use sessions to pass information between
actions, but not to other packages.

Configure shared session using Package SDK alla
pagina 2405

Package SDK provides configuration for the SDK
users to create and use shared sessions. Sessions
are seamlessly shared between different bots to
share resources between them. This means that if
a session has been created, the other TaskBots can
read and update the session and vice versa.

Create a bot to test the custom package alla pagina
2434

A shared session enables you to reuse actions
between TaskBots that run concurrently, for
example, using the same Excel file to pass values.

Actions
Any action class supports only one method as an entry point. Annotate all parameters of the entry point
method with Idx. There are three types of actions:
• Command\Action (default choice)
• Iteratore
• Condizione

Importante:  If you do not provide a public setter to member variables with Inject, compilation errors
occur.

© 2023 Automation Anywhere. All rights reserved.     2376



    Automation Anywhere - Crea

Concetti correlati
Standard coding practices and guidelines for developing packages alla pagina 2367
This topic covers standard coding practices and guidelines that help to ensure the development of high
quality packages.
Annotations alla pagina 2412
This section provides reference information about the annotations used to create Automation Anywhere
packages.
Attività correlate
Set up the Java project alla pagina 2366
Set up an integrated development environment (IDE) for Java, including Automation Anywhere custom
annotations to develop an action package that you can upload to your Control Room.
Develop a sample package alla pagina 2369
Develop your own package and upload it to an Control Room to provide custom actions for bots.

Return a value from an action
Set the following properties on CommandPkg to store the action output in a variable.

Action return values

• return_type
Defines the return type of the action. It usually matches the entry method return type.

• return_required
When the value is set to true the return value is required.

• return_label
A description of the UI label for the variable value.

Esempio: Convert a sourceString to uppercase and assign the result to
returnTo

//BotCommand makes a class eligible for being considered as an action.
@BotCommand

//CommandPks adds required information to be displayable on the UI.
@CommandPkg(
  //Unique name inside a package and label to display.
  name = "uppercase", label = "[[Uppercase.label]]",  
  node_label = "[[Uppercase.node_label]]",  description =
 "[[Uppercase.description]]", icon = "pkg.svg", 
  
  //Return type information. return_type ensures only the right kind of
 variable is provided on the UI. 
  return_label = "[[Uppercase.return_label]]", return_type =
 STRING, return_required = true)
public class Uppercase {
 
 //Messages read from a fully qualified property file name and provides i18n
 capability.
 private static final Messages MESSAGES = MessagesFactory
   .getMessages("com.automationanywhere.botcommand.samples.messages");
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 //Identify the entry point for the action. Returns a Value <String> because
 the return type is String. 
 @Execute
 public Value<String> action(
   //Idx 1 would be displayed first, with a text box for entering the value.
   @Idx(index = "1", type = TEXT) 
   //UI labels.
   @Pkg(label = "[[Uppercase.sourceString.label]]") 
   //Ensure that a validation error is thrown when the value is null.
   @NotEmpty 
   String sourceString,

Concetti correlati
How to examples alla pagina 2375
This section contains code examples and explanations about how to code some basic bot capabilities.

Expose property attributes of action
The property values of an action can be exposed by setting the following properties on CommandPkg.

Action property values

Property Attributes Descrizione

property_name The name of the property, unique at action level, in auto-
complete box this name would appear.

property_description A description of the property.

property_type The data type on which property operates, only if the type
matches, the property will be appear in the auto-complete
box.

property_return_type The data type for what property returns. If this type does
not match with the field type where it is used, there will be
validation error.

@BotCommand
@CommandPkg(label = "Uppercase", name = "uppercase", description="Converts
 the string to upper case", 
icon = "uppercase.svg", node_label="Convert {{sourceString}} to upper case|
 and assign the result to {{returnTo}}|", 
return_type=DataType.STRING, return_required = true, return_label="Assign
 the output to variable", 
property_name="uppercase", property_description="Converts the string to
 upper case", property_type=DataType.STRING, 
property_return_type=DataType.STRING) public class UpperCase {
 
    @Execute
    public Value<String> convert(
            @Idx(index = "1", type=TEXT)
            @Pkg(label="Source string")
            @NotEmpty
            String sourceString){
        return new StringValue(sourceString.toUpperCase());
    }
}
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For example, the above class in the UI will look like:

Concetti correlati
How to examples alla pagina 2375
This section contains code examples and explanations about how to code some basic bot capabilities.

Organize and group actions when developing packages
Review the provided examples on how to add and group actions during the package SDK development
process.
Esempio: Addactions

@BotCommand

//CommandPks adds required information to be dispalable on the UI.
@CommandPkg(
  //Unique name inside a package and a label to display.
  name = "concatenate", label = "[[Concatenate.label]]", 
  node_label = "[[Concatenate.node_label]]", description =
 "[[Concatenate.description]]", icon = "pkg.svg", 
  
  //Return type information. return_type ensures only the right kind of
 variable is provided on the UI. 
  return_label = "[[Concatenate.return_label]]", return_type = STRING,
 return_required = true)

Esempio: Groupactions

© 2023 Automation Anywhere. All rights reserved.     2379



    Automation Anywhere - Crea

Use the group_label to ConcatenateGroup which it is displayed in the UI also as
ConcatenateGroup. When the group_label is not used, you will get all the actions in the respective
package.

@BotCommand

//CommandPks adds required information to be dispalable on the UI.
@CommandPkg(
  //Provide a unique name inside a package and a label to display.
  group_label = "ConcatenateGroup", name = "concatenateWithGroup", label =
 "concatenateWithGroup",
  node_label = "[[Concatenate.node_label]]", description =
 "[[Concatenate.description]]", icon = "pkg.svg", 
  
  //Return type information. return_type ensures only the right kind of
 variable is provided on the UI. 
  return_label = "[[Concatenate.return_label]]", return_type = STRING,
 return_required = true)
public class ConcatenateWithGroup {

Input types - UI elements
The user interface (UI) elements are the input controls used to receive inputs in an action while building a
bot.

The following examples show the supported input types. Use the UI elements to create user interface (UI)
designs to build the Control Room interfaces. For instance, if you need an input as text then, use TEXT, if
you need a radio button, select RADIO, and so on. This topic is based on the SampleUI sample available
within the Package SDK in the following location: <PackageSDK>\src\main\java\com\automationanywhere
\botcommand\samples\commands\ui\SampleUI.java.

1. Make sure you have imported the following packages to ensure all the functionalities works as
described in the sample.

import com.automationanywhere.commandsdk.annotations.Idx;
import com.automationanywhere.commandsdk.annotations.Pkg;
import com.automationanywhere.commandsdk.annotations.rules.CodeType;
import com.automationanywhere.commandsdk.annotations.rules.VariableType;

2. Add the @BotCommand annotation to make a class as an Action in the Control Room. For more
information on annotations, see Annotations alla pagina 2412.

@BotCommand

3. Add the @CommandPkg annotation to define all the UI related components - labels, description, and
name.

@CommandPkg(label = "UI Demo", description = "Demonstrates the provided
 UI elements", name = "uiDemo")

4. Create a class and define the fields as described below.
a. Annotate the method with @Execute to execute the method during compilation.
b. In this sample, @Idx and @Pkg are used as a member of the class, so you should use set and

get methods to define them.
1. @Idx - Defines the index of an action.
2. @Pkg - Defines all the parameters and member variables shown in the interface. Must be

accompanied by the @Idx, if not this annotation is ignored.
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3. @Inject - To receive value from the UI using the member class, @Inject is required at
field levels.

@BotCommand
@CommandPkg(label = "UI Demo", description = "Demonstrates the
 provided UI elements", name = "uiDemo")
public class SampleUI {
        @Idx(index = "1", type = TEXT)
        @Pkg(label = "Text type")
        @Inject
        String text;

    @Execute
    public String getText() {
        return text; 
    } 
    public void setText(String text)  {
        this.text = text; 
    }
}

5. Drag the action into canvas and you will be able to input a string in the text field. You will see an input
box similar to this image.

UI element - Number field
Use the Number type to create an UI element that will accept a number. Using the below sample you will
be able to create a field that will accept only numbers.

@BotCommand
@CommandPkg(label = "UI Demo", description = "Demonstrates the provided UI
 elements", name = "uiDemo")
public class SampleUI {
        @Idx(index = "2", type = NUMBER)
        @Pkg(label = "Number type")
        @Inject
        String num;

    @Execute
    public String getNum() {
        return num; 
    } 
    public void setNum(String num)  {
        this.num = num; 
    }
}
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Other UI elements
It is possible to create other UI components like: Boolean, Radiobutton, Number, Variable, Code, Dictionary,
List, Date/Time, and so on. To get a complete list of UI elements supported, see <PackageSDK>\src\main
\java\com\automationanywhere\botcommand\samples\commands\ui\SampleUI.java.

UI validations supported
The following UI validations are also supported:
• @NotEmpty means that the UI field needs an input at the bot design time.
• @ LocalFile refers to a local file from a user machine.
• @NumberIntegers refers to a number value that you can provide, such as, a float or a double input kind.

Create custom variables using Package SDK
When using Automation 360, you can create custom variables using the SDK package.

Using custom variables

Use Automation 360 to create a custom variable. This is a system variable and is used as other bot
variables, except it is read-only and the value is calculated instead of being assigned.

Required annotations

For creating a variable, the following annotations are required:

Annotazione Utilizzo

BotCommand Use the BotCommand annotation with the
variable as commandType. This ensures that the
plain old Java object (POJO) is suitable for creating
an Automation 360 variable.

CommandPkg These values are used when creating a package.
Provide a name, label, and description to the
annotation.

Idx Annotate all the parameters and member variables
that are required and help with the validation
check. Alternatively they might be displayed in the
interface for the input. Provide the index (Idx) and
the type.

Pkg Annotate all the parameters and member variables
that will be shown in the interface. This annotation
will be ignored if it is not accompanied by the Idx.

VariableExecute The method that has to be called for returning
the variable value. This method does not
accept any input parameters. Sessions and
GlobalSessionContext are available though
setter injection.
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Use case example

The following use case shows how to return the current time for the system default zone.
1. Create the POJO class with the business logic:

public class Now {
 
 public DateTimeValue now() {
  Instant instant = Instant.now();
  ZonedDateTime now = instant.atZone(ZoneId.systemDefault());
  return new DateTimeValue(now);
 }

}

2. Annotate the POJO class to enable it for the Automation 360 variable and to create the package:

@BotCommand(commandType = BotCommand.CommandType.Variable)
@CommandPkg(description = "The current datetime at system default zone.",
 name = "Now", label = "", variable_return_type = DataType.DATETIME)
public class Now {
 
 public DateTimeValue now() {
  Instant instant = Instant.now();
  ZonedDateTime now = instant.atZone(ZoneId.systemDefault());
  return new DateTimeValue(now);
 }

}

3. Annotate the now method to denote it to be the execute method.

@VariableExecute
 public DateTimeValue now() {
  Instant instant = Instant.now();
  ZonedDateTime now = instant.atZone(ZoneId.systemDefault());
  return new DateTimeValue(now);
 }

Every variable must have one test VariableExecute method.

Concetti correlati
How to examples alla pagina 2375
This section contains code examples and explanations about how to code some basic bot capabilities.

Utilizzo di EntryList
EntryList consente di accettare un numero qualsiasi di parametri attraverso il creatore di bot. La struttura
dei parametri è definita nelle azioni Automation 360.

Esempio: EntryList

L'esempio seguente mostra come creare un parametro con il nome della coppia di villaggi.

@BotCommand
@CommandPkg(label = "EntryList example", description = "EntryList example",
 icon = "sample.svg", name = "entryListExample")
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public class EntryListExample {
 // UI display for ENTRYLIST 1.1, the linking is done based on the ENTRYLIST
 title.
 // This should be added as a child of the ENTRYLIST, however it should not
 be part of options.
 // The EntryList does not need a setter or Inject as the value is provided
 inside the ENTRYLIST.
 @Idx(index = "1.3", type = TEXT, name = "NAME")
 @Pkg(label = "Name", default_value_type = DataType.STRING)
 @NotEmpty
 private String name;
 //Linked to 1.2 through title.
 @Idx(index = "1.4", type = TEXT, name = "VILLAGE")
 @Pkg(label = "village", default_value_type = STRING)
 private String city;
 @Execute
 public void setParameter(
   // Add the entryList, the values are accepted as a list of values.
   // Provide the column header for the tabular display of accepted entries.
   // In Pkg, provide a unique title.
   // Provide Idx for each option separately, this is needed to
   // have the correct UI type when the entry form is presented.
   // Add only columns to options, you cannot add their definitions.
   @Idx(index = "1", type = ENTRYLIST, options = {
     @Idx.Option(index = "1.1", pkg = @Pkg(title = "NAME", label = "Name")),
     @Idx.Option(index = "1.2", pkg = @Pkg(title = "VILLAGE", label =
 "village")),
   })
   //Label that is desplayed in the UI
   @Pkg(label = "Provide name value entries")
   //Header of the entry form
   @EntryListLabel(value = "Provide entry")
   //Button label which displays the entry form
   @EntryListAddButtonLabel(value = "Add entry")
   //Unique rule for the column, this value is the column TITLE. 
   @EntryListEntryUnique(value = "NAME")
   //Message to dispaly in the table when no entries are present.
   @EntryListEmptyLabel(value = "No parameters added")
     List<Value> entryList) {

 }

Here is another example of the EntryList, define the values of the EntryList usage.

//Entry list//
@Idx(index = "1", type = ENTRYLIST, options = {
      @Idx.Option(index = "1.1", pkg = @Pkg(title = HEADER_ENABLED, label =
 "[[HEADER1]]")),
      @Idx.Option(index = "1.2", pkg = @Pkg(title = HEADER_NAME, label =
 "[[HEADER1]]")),
      @Idx.Option(index = "1.3", pkg = @Pkg(title = HEADER_VALUE, label =
 "[[HEARER3]]"))
})
@Pkg(label = "customHeaderslabel")
@EntryListLabel(value = "customHeaderlabel")
@EntryListAddButtonLabel(value = "add.header")
@EntryListEmptyLabel(value = "no.header")
@Inject
List<Value> customHeaders;

Concetti correlati
How to examples alla pagina 2375
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This section contains code examples and explanations about how to code some basic bot capabilities.

Utilizzo di espressioni regolari
Utilizza espressioni regolari (regex) per creare modelli di stringa che consentano di associare, individuare o
gestire il testo in Java. Insieme, i caratteri alfabetici e quelli speciali definiscono un modello logico. Utilizza
il modello per confrontare le stringhe di testo per verificare se corrispondono al modello definito.

Nota:  Regular expression (regex) does not recognize [\b] as a Backspace command. Use \\b to use
Backspace instead.

Esempio: Corrispondenza Regex

Use MatchesRegex to test the string pattern.
Nell'esempio seguente, il modello di input inizia dall'alfabeto inglese, dalle lettere maiuscole alle minuscole
(A-Z/a-z) e termina con un valore numerico.

@Idx(index = "1", type = TEXT)
@Pkg(label = "Field label", description = "Field description]")
@MatchesRegex("^[A-Za-z]\w*")
@NotEmpty
String cell

Se il modello non corrisponde, viene visualizzato il seguente messaggio: Must match pattern.
Concetti correlati
How to examples alla pagina 2375
This section contains code examples and explanations about how to code some basic bot capabilities.

FILE2 (Regex) attribute
A regular expressions (RegEx) are patterns of string defined to search for a file in a specified path. Use the
FILE2 attribute when using regular expressions (regex) to create string patterns.
For instance: If you want to search a folder path for a file (For example Hello.txt)which contains a
certain string. . You will use File2 attribute type to enter the following regex pattern: Hell or ell which
will find the file that matches the search criteria. This topic is based on the File2TypeDemo sample available
within the Package SDK in the following location <PackageSDK>\src\main\java\com\automationanywhere
\botcommand\samples\commands\basic\types\File2TypeDemo.java.

Using the FILE2

1. Make sure you have imported the following packages to ensure all the functionalities works as
described in the sample.

import com.automationanywhere.commandsdk.annotations.*;
import com.automationanywhere.commandsdk.model.AttributeType;
import org.apache.logging.log4j.LogManager;
import org.apache.logging.log4j.Logger;

© 2023 Automation Anywhere. All rights reserved.     2385



    Automation Anywhere - Crea

2. Add the @BotCommand annotation to make a class as an Action in the Control Room. For more
information on annotations, see Annotations alla pagina 2412.

@BotCommand

3. Add the @CommandPkg annotation to define all the UI related components - labels, description, icon,
return type, and name.

@CommandPkg(label = "[[File2TypeDemo.label]]", description =
 "[[File2TypeDemo.description]]", icon = "sample.svg", name =
 "file2TypeDemo")

4. Create a method (For example: regexFile) within your class and define the fields as described below.
a. Annotate the method with @Execute to execute the method during compilation.
b. In the below sample, @Idx, @Pkg, and @NotEmpty are defined as a parameters of the method.

If they are used as a member of the class, then you should use set and get methods to define
them.
1. @Idx - Defines the index of an action. (@Idx(index = "1", type =

 AttributeType.FILE2))
2. @Pkg - Defines all the parameters and member variables shown in the interface

(@Pkg(label = "[[File2TypeDemo.localFile.label]]") ). Must be accompanied
by the @Idx, if not this annotation is ignored.

3. @NotEmpty - Defines that this parameter cannot be empty (@NotEmpty @LocalFile
 FileValue fileValue)).

@BotCommand
@CommandPkg(label = "[[File2TypeDemo.label]]",
    description = "[[File2TypeDemo.description]]", icon =
 "sample.svg", name = "file2TypeDemo")
public class File2TypeDemo {
    private static Logger logger =
 LogManager.getLogger(File2TypeDemo.class);

    @Execute
    public void regexFile(
        @Idx(index = "1", type = AttributeType.FILE2) 
        @Pkg(label = "[[File2TypeDemo.localFile.label]]") 
        @NotEmpty @LocalFile FileValue fileValue)

5. Build and upload the custom package to the Control Room. For more information on uploading the
package, see Using the package SDK alla pagina 2370.

6. Create a bot.
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7. Drag the action into canvas and you will be able to input the regex to find a file. You will see an input
box similar to this image.

Print the Regex - Folder name and the File location
Use the Logger interface obtained from Log4j package to provide information of the objects being
manipulated. In the below sample you will be able to log the folder name and the local file location by using
the debug method.

@BotCommand
@CommandPkg(label = "[[File2TypeDemo.label]]",
  description = "[[File2TypeDemo.description]]", icon = "sample.svg", name =
 "file2TypeDemo")
public class File2TypeDemo {
  private static Logger logger = LogManager.getLogger(File2TypeDemo.class);

  @Execute
  public void regexFile(
    @Idx(index = "1", type = AttributeType.FILE2) @Pkg(label =
 "[[File2TypeDemo.localFile.label]]") @NotEmpty @LocalFile FileValue
 fileValue) {
    if (fileValue.isRegex()) {

      RegexFile regexFile = fileValue.getRegex();
      logger.debug("folder name {}", regexFile.getFolder());
      logger.debug("local file location {}",
 regexFile.getFileNamePattern().toString());
    } else {
      logger.debug("Regex option is not selected");
    }
  }

Create a condition using Package SDK
When using Automation 360, you can create a condition with the SDK package.
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Using a condition

If and Loop are branching constructs in Automation 360. They are used to run a sequence of actions when
a condition is set to true. A condition is used along with the If and Loop packages. A condition takes a set
of inputs and returns a Boolean value.

Required annotations

For creating a condition, the following annotations are required:

Annotazione Utilizzo

BotCommand Use the BotCommand annotation with the
condition as commandType. This ensures that
the plain old Java object (POJO) is suitable for the
creation of an Automation 360 condition.

CommandPkg These values are used when creating a package.
Provide a name, label, and description to the
annotation.

Idx Annotate all the parameters and member variables
that are required and help with the validation
check, or they might be displayed in the interface
for the input. Provide the index (Idx) and the type.

Pkg Annotate all the parameters and member variables
that will be shown in the interface. This annotation
will be ignored if it is not accompanied by the Idx.

ConditionTest The method that has to be called for testing the
condition. It must return a Boolean value. If the
method accepts parameters, then annotate them
with Idx.

Use case example

The following use case verifies whether the given number is greater than the other number.
1. Create the POJO class with the business logic:

public class IsGreater {

 public Boolean checkGreater(Double first, Double checkAgainst) {
  return first > checkAgainst;
 }

}

2. Annotate the POJO class to enable it for the Automation 360 condition and to create the package:

@BotCommand(commandType = Condition)
@CommandPkg(label = "Is greater condition", name = "IsGreater",
 description = "Checks if the given number is greater than the other.",
 node_label = "{{first}} > {{checkAgainst}} ")
public class IsGreater {
 public Boolean checkGreater(Double first, Double checkAgainst) {
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  return first > checkAgainst;
 }
}

3. Annotate the checkGreater method to indicate that this method should be used as a comparison
method.

@ConditionTest
public Boolean checkGreater(Double first, Double checkAgainst) {
 return first > checkAgainst;
}

Every condition must have exactly one test condition method.
4. Annotate the parameters of the checkGreater method with Idx and Pkg.

Add @NotEmpty to ensure the value is not null.

@ConditionTest
public Boolean checkGreater(
 @Idx(index = "1", type = AttributeType.NUMBER) @Pkg(label = "Number to
 check") @NotEmpty Double first,

 @Idx(index = "2", type = AttributeType.NUMBER) @Pkg(label = "Number to
 compare against") @NotEmpty Double checkAgainst) {

 return first > checkAgainst;
}

The attribute type number returns a Double.

Concetti correlati
How to examples alla pagina 2375
This section contains code examples and explanations about how to code some basic bot capabilities.

Add a condition in a custom package for If condition
Add conditions in a custom package.

Create condition values in an Action

• To create a condition, set commandType property of BotCommand annotation with value as
Condition.

• To define the entry method of the condition, use the annotation ConditionTest.

@BotCommand(commandType = Condition)
@CommandPkg(label = "File exists", name = "fileExists",
        description = "Checks if the file exists.",
        node_label = "file exists at {{sourceFilePath}}", icon = "")
public class Exist extends AbstractCondition {
    @ConditionTest
    public boolean test(@Idx(index = "1", type = FILE) @LocalFile @Pkg(label
 = "File path") @NotEmpty String sourceFilePath,
                        @Idx(index = "2", type = NUMBER) @Pkg(label = "How
 long you would like to wait for this condition 
                        to be true?(Seconds)",
                                default_value = "0", default_value_type =
 DataType.NUMBER)
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                        @GreaterThanEqualTo("0") @LessThanEqualTo("99999")
 @NotEmpty @NumberInteger Double waitTimeout) {
 
        // Add the logic to check for the condition
    }   
}

The following example verifies if the provided boolean value is false.
Set commandType to Condition.

@BotCommand(commandType = Condition)
@CommandPkg(label = "False condition example", name =
 "conditionalTypeExample",
        description = "Checks if the boolean value is false.")
public class ConditionalTypeExample {
 
  @ConditionTest
     public Boolean validate(
             @Idx(index = "1", type = AttributeType.BOOLEAN)
             @VariableType(BOOLEAN)
             @Pkg(label = "Boolean variable", default_value_type = BOOLEAN)
 @NotEmpty Boolean variable
     ) {
         return variable == null ? false : !variable ;
     }

Concetti correlati
How to examples alla pagina 2375
This section contains code examples and explanations about how to code some basic bot capabilities.

Create an iterator using Package SDK
In Automation 360, you can create an iterator with the SDK package. An iterator is used to loop through
multiple objects of similar type and is used with the Loop package. It consists of two methods, next and
hasNext, which return the actual object and a boolean value.

Required annotations

When iterator is used, the next method returns the next available value. If no more values are available,
an exception is shown. The hasNext method checks for other values and returns false if no more values
are available. In Automation 360, when the loop is executed, hasNext() is called first, and next() is
called only if hasNext() returned a true value.
For creating an iterator, the following annotations are required.

Annotazione Utilizzo

BotCommand Use the BotCommand annotation with an iterator as the commandType.
This ensures that the plain old Java object (POJO) is eligible for creating an
Automation 360 iterator.

CommandPkg When creating a package, provide a name, label, and description to the
annotation.

Idx Annotate all parameters and member variables that are required and help with
the validation check, or they can be displayed in the interface for the input.
Provide the Idx and the type.
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Annotazione Utilizzo

Pkg Annotate all parameters and member variables that will be displayed in the
interface. This annotation will be ignored if it is not accompanied by the Idx.

HasNext The method that has to be called for testing if the iteration has more elements
(returns true if next() returns an element rather than throwing an
exception). It must return a Boolean value.
If the method accepts parameters, then they must be annotated with the Idx.
The hasNext method verifies it and returns false if no more values are
available. InAutomation 360, when Loop is executed, hasNext() is called
first. next() is called only if hasNext() returns a true value.

Next The method returns the next available value in the iteration. The return type is
a value. If no more value is available, an exception is shown.

Use case example
The example use case loops through number of times, for example, for (int i=0; I<n; i++) Java
construct. It accepts the value of n from the Bot Creator when the bot is created.
1. Make sure you have imported the following packages to ensure all the functionalities works as

described in the sample.

import com.automationanywhere.botcommand.data.Value;
import com.automationanywhere.botcommand.data.impl.NumberValue;
import com.automationanywhere.commandsdk.annotations.BotCommand;
import com.automationanywhere.commandsdk.annotations.CommandPkg;
import com.automationanywhere.commandsdk.annotations.HasNext;
import com.automationanywhere.commandsdk.annotations.Idx;
import com.automationanywhere.commandsdk.annotations.Inject;
import com.automationanywhere.commandsdk.annotations.Next;
import com.automationanywhere.commandsdk.annotations.Pkg;
import
 com.automationanywhere.commandsdk.annotations.BotCommand.CommandType;
import
 com.automationanywhere.commandsdk.annotations.rules.GreaterThanEqualTo;
import com.automationanywhere.commandsdk.annotations.rules.NotEmpty;
import com.automationanywhere.commandsdk.annotations.rules.NumberInteger;
import com.automationanywhere.commandsdk.model.AttributeType;
import com.automationanywhere.commandsdk.model.DataType;

2. Create the POJO class with the business logic.
Ensure that the POJO has a method and returns a boolean value. This will act as the comparison
method.

@BotCommand(commandType=CommandType.Iterator)
@CommandPkg(return_label = "Return the value in variable", node_label =
 ": {{times}} times", 
label = "Iterator demo", description = "Iterate number of times", name =
 "iteratorTypeDemo", return_type = DataType.NUMBER)
public class IteratorTypeDemo {
    @Idx(index = "1", type = AttributeType.NUMBER)
    @Pkg(label = "times", default_value = "10", default_value_type =
 DataType.NUMBER)
    @GreaterThanEqualTo("0")
    @NumberInteger
    @NotEmpty
    @Inject
 private Double times = 10d;
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 private Double counter = 0d;

    @HasNext
    public boolean hasNext() {
  return counter < times;
    }

    @Next
    public Value<Double> next() throws Exception{
  if (counter >= times)
   throw new Exception("Counter '"+ counter +"' is exceed the times limit
 '"+times+"'");

  counter++;
        NumberValue result = new NumberValue();
        result.set(counter);
        return result;
    }

    public void setTimes(Double times) {
        this.times = times;
    }
}

3. Annotate the POJO class to enable it for the Automation 360 iterator and to create a package.

@BotCommand(commandType = CommandType.Iterator)
@CommandPkg(return_label = "Return the value in variable", node_label =
 ": {{times}} times",
 label = "Iterator demo", description = "Iterate number of times", name =
 "iteratorTypeDemo", return_type = DataType.NUMBER)
public class IteratorTypeDemo {

 private Double times = 10 d;
 private Double counter = 0 d;

 public boolean hasNext() {
  return counter < times;
 }

4. Annotate the hasNext() and next() method appropriately.

@HasNext
public boolean hasNext() {
 return counter < times;
}

@Next
public Value < Double > next() throws Exception {
 if (counter >= times)
  throw new Exception("Counter '" + counter + "' is exceed the times
 limit '" + times + "'");

 counter++;
 NumberValue result = new NumberValue();
 result.set(counter);
 return result;
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}

The methods are named in easy-to-use way and are in parallel with the Java iterator interface. There
is no restriction from the SDK side when naming methods.
In an iterator, do not use parameter methods, but use setter injection.

5. Annotate the variables with Idx and Pkg.
Add @NotEmpty to ensure the value is not null, and add @GreaterThanEqualTo to ensure the
value is always greater than 0.

@Idx(index = "1", type = AttributeType.NUMBER)
@Pkg(label = "times", default_value = "10", default_value_type =
 DataType.NUMBER)
@GreaterThanEqualTo("0")
@NotEmpty
@Inject
private Double times = 10 d;

The attribute type number returns a Double.

Concetti correlati
How to examples alla pagina 2375
This section contains code examples and explanations about how to code some basic bot capabilities.

Create a trigger using Package SDK
When using Automation 360, you can create a trigger using the SDK package.

Using a trigger

Use Automation 360 to create a trigger. A trigger launches a bot when certain conditions are met and waits
until conditions have changed or stopped. When the conditions of the trigger are matched, the run method
is called to signal the trigger.

Required annotations

For creating a trigger, the following annotations are required:

Annotazione Utilizzo

BotCommand Use the BotCommand annotation with the
trigger as commandType. This ensures that the
plain old Java object (POJO) is suitable for creating
the trigger with Automation 360.

CommandPkg These values are used when creating a package.
Provide a name, label, and description to the
annotation.

Idx Annotate all the parameters and member variables
that are required and help with the validation
check. Alternatively, they might be displayed in the
interface for the input. Provide the index (Idx) and
the type.
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Annotazione Utilizzo

Pkg Annotate all the parameters and member variables
that will be shown in the interface. This annotation
will be ignored if it is not accompanied by the Idx.

StartListen Starts the trigger listener.

TriggerId A trigger ID, which is required for stopping the
trigger.

TriggerRunnable Provides the runnable. Calling the runnable sends a
signal that launches a bot associated with a trigger.

Use case example

The following use case shows how to create a timer trigger that triggers a bot at a regular interval.
1. Create the POJO class with the business logic:

public class TriggerDemo {
 
 private static final Timer TIMER = new Timer(true);
 
 public void startTrigger(Double interval) {
  TimerTask timerTask = new TimerTask() {

   @Override
   public void run() {
    // Do nothing

   }
  };

  TIMER.schedule(timerTask, interval.longValue());
 }

}

Multiple triggers of the same type can exist in a bot. All triggers are identified by a triggerId.
2. Add a triggerId to the class:

@TriggerId
 private String triggerUid;
 
 public String getTriggerUid() {
  return triggerUid;
 }

 public void setTriggerUid(String triggerUid) {
  this.triggerUid = triggerUid;
 }

3. Store the TimerTask separately so that when you want to stop a specific trigger, use the
triggerId.

private static final Map<String, TimerTask> taskMap = new
 ConcurrentHashMap<>();
 
 public void startTrigger(Double interval) {
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  TimerTask timerTask = new TimerTask() {

   @Override
   public void run() {
    // Do nothing

   }
  };
        taskMap.put(this.triggerUid, timerTask);
  TIMER.schedule(timerTask, interval.longValue());
 }

4. Start a trigger when conditions are met. Accept a runnable and call it appropriately.

@TriggerRunnable
 private Runnable runnable;
 
 public Runnable getRunnable() {
  return runnable;
 }

 public void setRunnable(Runnable runnable) {
  this.runnable = runnable;
 }
 
 public void startTrigger(Double interval) {
  TimerTask timerTask = new TimerTask() {

   @Override
   public void run() {
    runnable.run();

   }
  };
        taskMap.put(this.triggerUid, timerTask);
  TIMER.schedule(timerTask, interval.longValue());
 }

5. Stop the trigger, either individually (use a triggerId), or stop all triggers at the same time
(StopAllTriggers).

/*
  * Cancel all the task and clear the map.
  */
 @StopAllTriggers
 public void stopAllTriggers() {
  taskMap.forEach((k, v) -> {
   if (v.cancel()) {
    taskMap.remove(k);
   }
  });
 }

 /*
  * Cancel the task and remove from map
  *
  * @param triggerUid
  */
 @StopListen
 public void stopListen(String triggerUid) {
  if (taskMap.get(triggerUid).cancel()) {
   taskMap.remove(triggerUid);
  }
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 }

6. Add the remaining annotations.

@BotCommand(commandType = BotCommand.CommandType.Trigger)
@CommandPkg(label = "Demo Trigger", description = "Demo Trigger", icon =
 "email.svg", name = "demoTrigger")
public class TriggerDemo {
//Other code

 @StartListen
 public void startTrigger(@Idx(index = "1", type = AttributeType.NUMBER)
 @Pkg(label = "Please provide the interval to trigger in seconds",
 default_value = "120", default_value_type = DataType.NUMBER)
 @GreaterThan("0")
 @NumberInteger
 @NotEmpty
 Double interval) {
 //Other code
 }

}

Concetti correlati
How to examples alla pagina 2375
This section contains code examples and explanations about how to code some basic bot capabilities.

Custom triggers - pull and push mechanism
The examples provided in this topic demonstrate how to create time-based and event-based triggers, pull
(link TriggerDemo) and push (SimpleMessageListenerContainer) mechanisms using the SDK
package.

Esempio: Time-based triggers - Pull mechanism

The required conditions of triggering are tested at the regular interval, in seconds.
• A trigger checks the database (DB) at regular intervals and if the SQL (DB) value that a user provides is

more than 0, then the timer-based trigger is triggered.
• When the event occurs, it runs the consumer.accept(<RecordValue Instance>) method and

triggers an associated bot.
• It verifies the conditions at each run.
• Add the valid DB driver in the build gradle file to run this example.

This example is an extension of the timer-based trigger (TriggerDemo) and demonstrates the trigger
pull mechanism.

Nota:  This is an illustrative example and do not use it in the production environment.

@BotCommand(commandType = BotCommand.CommandType.Trigger)
@CommandPkg(label = "JDBC Query Trigger", description = "JDBC Query
 Trigger", icon = "jdbc.svg", name = "jdbcQueryTrigger",
  return_type = RECORD, return_name = "TriggerData", return_description =
 "Available keys: triggerType")
public class DBStatus {
 
 private static Logger logger = LogManager.getLogger(DBStatus.class);
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 // Map storing multiple tasks
 private static final Map<String, TimerTask> taskMap = new
 ConcurrentHashMap<>();
 private static final Timer TIMER = new Timer(true);

 @TriggerId
 private String triggerUid;
 @TriggerConsumer
 private Consumer consumer;

 /*
  * Starts the trigger.
  */
 @StartListen
 public void startTrigger(
   @Idx(index="1", type = AttributeType.TEXT)
   @Pkg(label = "Provide the database driver class")
   @NotEmpty
   String driverClassName,
   
   @Idx(index="2", type = AttributeType.TEXT)
   @Pkg(label = "Provide the Jdbc connection string")
   @NotEmpty
   String jdbcUrl,
   
   @Idx(index="3", type = AttributeType.TEXT)
   @Pkg(label = "Provide the user Name")
   @NotEmpty
   String userName,
   
   @Idx(index="4", type = AttributeType.CREDENTIAL)
   @Pkg(label = "Provide the password")
   @NotEmpty
   SecureString password,
   
   @Idx(index="5", type = AttributeType.TEXT)
   @Pkg(label = "Provide the SQL to check the records")
   @NotEmpty
   String sqlQuery,
   
   @Idx(index = "6", type = AttributeType.NUMBER)
   @Pkg(label = "Provide the interval to query in seconds", default_value =
 "300", default_value_type = DataType.NUMBER)
   @GreaterThan("0")
   @NumberInteger
   @NotEmpty
   Double interval) {
  
  DataSource dataSource = getDataSource(driverClassName, jdbcUrl, userName,
 password);
  
  TimerTask timerTask = new TimerTask() {

   @Override
   public void run() {
    logger.debug("checking DB");
    try {
     if(checkRecordsExist(dataSource.getConnection(), sqlQuery)){
      consumer.accept(getRecordValue());
      return;
     }
    } catch (SQLException e) {
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     logger.warn(e.getMessage(),e);
     logger.warn("Trigger is still running.");
    }
    logger.debug("no records found");

   }
  };

  taskMap.put(this.triggerUid, timerTask);
  TIMER.schedule(timerTask, interval.longValue(), interval.longValue());
 }

 private RecordValue getRecordValue() {
  List<Schema> schemas = new LinkedList<>();
  List<Value> values = new LinkedList<>();
  schemas.add(new Schema("triggerType"));
  values.add(new StringValue("DBStatus"));

  RecordValue recordValue = new RecordValue();
  recordValue.set(new Record(schemas,values));
  return recordValue;
 }
 /*
  * Cancel all the tasks and clear the map.
  */
 @StopAllTriggers
 public void stopAllTriggers() {
  taskMap.forEach((k, v) -> {
   if (v.cancel()) {
    taskMap.remove(k);
   }
  });
 }

 /*
  * Cancel the task and remove from the map
  *
  * @param triggerUid
  */
 @StopListen
 public void stopListen(String triggerUid) {
  if (taskMap.get(triggerUid).cancel()) {
   taskMap.remove(triggerUid);
  }
 }

    public static DataSource getDataSource(String driverClassName, String
 url, String userName,SecureString password) {
     BasicDataSource ds = new BasicDataSource();
     ds.setDriverClassName(driverClassName);
     ds.setUrl(url);
     ds.setUsername(userName);
     ds.setPassword(password.getInsecureString());
        return ds;
    }
 
    public static boolean checkRecordsExist(Connection con, String query)
         throws SQLException {
   
         Statement stmt = null;
         try {
             stmt = con.createStatement();
             ResultSet rs = stmt.executeQuery(query);
             rs.last();
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             if(rs.getRow() > 0)
              return true;
         } catch (SQLException e ) {
             throw new BotCommandException("Problem running statemnt", e);
         } finally {
             if (stmt != null) { stmt.close(); }
         }    
         return false;
     }  
 public String getTriggerUid() {
  return triggerUid;
 }
 public void setTriggerUid(String triggerUid) {
  this.triggerUid = triggerUid;
 }
 public Consumer getConsumer() {
  return consumer;
 }
 public void setConsumer(Consumer consumer) {
  this.consumer = consumer;
 }
}

Esempio: Event-based triggers - Push mechanism

The trigger waits for an event to occur, for example, a message listener to start listening.
• An event details are stored in the memory and a message listener waits for a message.
• When the event occurs, it runs the consumer.accept(<RecordValue Instance>) method and

triggers an associated bot..

The following example shows how to create a simple ActiveMQ message listener
(SimpleMessageListenerContainer) to demonstrate the trigger push mechanism.

@BotCommand(commandType = BotCommand.CommandType.Trigger)
@CommandPkg(label = "JMS Trigger", description = "JMS Trigger", icon =
 "jms.svg", name = "jmsTrigger",
  return_type = RECORD, return_name = "TriggerData", return_description =
 "Available keys: triggerType")
public class JMSQueue implements SessionAwareMessageListener {

 // Map storing multiple MessageListenerContainer
 private static final Map<String, MessageListenerContainer> taskMap = new
 ConcurrentHashMap<>();

 @TriggerId
 private String triggerUid;
 @TriggerConsumer
 private Consumer consumer;
 
 //This method is called by MessageListenerContainer when a message arrives.
 // At this point, the trigger get enabled 
 @Override
 public void onMessage(javax.jms.Message message, Session session) throws
 JMSException {
  consumer.accept(getRecordValue());

 }

 private RecordValue getRecordValue() {
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  List<Schema> schemas = new LinkedList<>();
  List<Value> values = new LinkedList<>();
  schemas.add(new Schema("triggerType"));
  values.add(new StringValue("JMSQueue"));

  RecordValue recordValue = new RecordValue();
  recordValue.set(new Record(schemas,values));
  return recordValue;
 }
 /*
  * Starts the trigger.
  * 
  * Use this method to setup the trigger, such as, setup the
 MessageListenerContainer and start it.
  */
 @StartListen
 public void startTrigger(@Idx(index = "1", type = AttributeType.TEXT)
 @Pkg(label = "Provide the broker URL")
 @NotEmpty
 String brokerURL, @Idx(index = "2", type = AttributeType.TEXT)
 @Pkg(label = "Provide the queue name")
 @NotEmpty
 String queueName) {
  
  if (taskMap.get(triggerUid) == null) {
   synchronized (this) {
    if (taskMap.get(triggerUid) == null) {
     SimpleMessageListenerContainer messageListenerContainer = new
 SimpleMessageListenerContainer();
     messageListenerContainer.setConnectionFactory(new
 PooledConnectionFactory(brokerURL));
     messageListenerContainer.setDestinationName(queueName);
     messageListenerContainer.setMessageListener(this);
     messageListenerContainer.start();
     taskMap.put(triggerUid, messageListenerContainer);

    }
   }
  }

 }

 /*
  * Cancel all the tasks and clear the map.
  */
 @StopAllTriggers
 public void stopAllTriggers() {
  taskMap.forEach((k, v) -> {
   v.stop();
   taskMap.remove(k);
  });
 }

 /*
  * Cancel the tasks and remove from the map
  *
  * @param triggerUid
  */
 @StopListen
 public void stopListen(String triggerUid) {
  taskMap.get(triggerUid).stop();
  taskMap.remove(triggerUid);
 }
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 public String getTriggerUid() {
  return triggerUid;
 }

 public void setTriggerUid(String triggerUid) {
  this.triggerUid = triggerUid;
 }

 public Consumer getConsumer() {
  return consumer;
 }

 public void setConsumer(Consumer consumer) {
  this.consumer = consumer;
 }

}

Concetti correlati
How to examples alla pagina 2375
This section contains code examples and explanations about how to code some basic bot capabilities.

Add debug logs of custom packages to bot_launcher.log file
You can add logs using log4j. The dependency is already added in the package SDK sample
build.gradle file. Review the logging info using RadioTypeDemo.java file.

Example 1: Logger info - Get region value using RadioTypeDemo class

1. Review the code example where the logger is added in the code, open the RadioTypeDemo.java
file located at <your latest package-sdk-2.0.9\src\main\java\com
\automationanywhere\botcommand\samples\commands\basic\types

@BotCommand
@CommandPkg(label = "[[RadioTypeDemo.label]]", 
description = "[[RadioTypeDemo.description]]", icon = "sample.svg", name
 = "radioTypeDemo")
public class RadioTypeDemo {

 private static Logger logger =
 LogManager.getLogger(RadioTypeDemo.class);
 
 @Execute
 public void getRegionValue(@Idx(index = "1", type = AttributeType.RADIO,
 options = {
   @Idx.Option(index = "1.1", pkg = @Pkg(label =
 "[[RadioTypeDemo.region.1.1.label]]", value = "us_east")),
   @Idx.Option(index = "1.2", pkg = @Pkg(label =
 "[[RadioTypeDemo.region.1.2.label]]", value = "us_west")),
   @Idx.Option(index = "1.3", pkg = @Pkg(label =
 "[[RadioTypeDemo.region.1.3.label]]", value = "us_central"))
 })
 @Pkg(label = "[[RadioTypeDemo.region.label]]")
 @NotEmpty
 String region) {
  logger.info("Selected region is {}", region);
 }

2. Build a simple bot from the Automation 360 Demo package and select a radio group: Radio Demo.
3. Select an appropriate region, such as, US East.
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4. Save and run the bot.
5. Access the folder where the logs were generated, the default log location: C:\ProgramData

\AutomationAnywhere\BotRunner\Logs\Bot_Launcher.log.
If the logs get roll back from the Bot_Launcher.log file, then logs will create a folder based on the
month when they were created, for example, 2021-May. Inside this folder, the logs will continue to
generate.

6. Open the Bot_Launcher.log file and review the log info for the RadioTypeDemo and selected
region is us_east.

Example 2: Assigning a value to clipboard
The following example accepts a user input or a variable and assigns it to clipboard.

@BotCommand
@CommandPkg(label = "Copy to",icon="assigntoclipboard.svg" ,name =
 "assignToClipboard", description
  = "Accepts user input or a variable and assigns it to Clipboard",
 node_label="{{value}}")
public class AssignToClipboard {

 private static Logger logger =
 LogManager.getLogger(AssignToClipboard.class);

 @Execute
 public static void assign(@Idx(index = "1", type = TEXT) @Pkg(label =
 "Value") @NotEmpty String
           value) {

  logger.trace("Assigning '{}' value to clipboard.", value);
 }
}

Concetti correlati
How to examples alla pagina 2375
This section contains code examples and explanations about how to code some basic bot capabilities.

Handle sessions in a custom package
You can extract a session using a session name from the SessionsMap. In the same package, you can use
sessions to pass information between actions, but not to other packages.

Configure the following attributes

• Apply an annotation to the class field and add a corresponding public setter.
• Retrieve the SessionsMap using the Sessions attribute.
• Set the variable type as Map<String, Object>.
• Set the attributeType: TEXT or SESSION. If type = TEXT, it is a regular session; if type =

 SESSION, it is a sharedSession.

Start a new session

@BotCommand
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@CommandPkg(label = "Start session", name = "startSession", description =
 "Start new session", 
icon = "pkg.svg", node_label = "start session {{sessionName}}|") public
 class Start {
 
    @Sessions
    private Map<String, Object> sessions;
     
    @Execute
    public void start(@Idx(index = "1", type = TEXT) @Pkg(label = "Session
 name", 
    default_value_type = STRING, default_value = "Default") @NotEmpty String
 sessionName) {
 
        // Check for existing session
        if (sessions.containsKey(sessionName))
            throw new
 BotCommandException(MESSAGES.getString("xml.SessionNameInUse",
 sessionName));
 
        // Do some operation
 
        // Create new session
        sessions.put(sessionName, new Session(operation));
    }
    public void setSessions(Map<String, Object> sessions) {
        this.sessions = sessions;
    }
}

End a session

@BotCommand
@CommandPkg(label = "End session", name = "endSession", description = "End
 session", icon = 
"pkg.svg", node_label = "End session {{sessionName}}|")
public class EndSession {
    @Sessions
    private Map<String, Object> sessions;
    @Execute
    public void end(
            @Idx(index = "1", type = TEXT) @Pkg(label = "Session name",
 default_value_type = STRING, 
            default_value = "Default") @NotEmpty String sessionName) {
                 
        sessions.remove(sessionName);   
    }  
    public void setSessions(Map<String, Object> sessions) {
        this.sessions = sessions;
    }
}
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Add a session
In the below example, string objects are used (although in real actions, you can use complex objects).

@BotCommand
@CommandPkg(label = "[[SessionDemo.label]]", description =
 "[[SessionDemo.description]]", icon = "sample.svg", name = "sessionDemo")
public class SessionDemo {

 // Sessions are provided as a Map. Actions can add or remove entries in
 this
 // Map.
 // The choice to reuse/overwrite/delete/add any Object in this Map belongs
 to
 // the actions, and the framework makes no assumption regarding it.
 @Sessions
 private Map<String, Object> sessionMap;

 @Execute
 public void execute(@Idx(index = "1", type = TEXT)
 @Pkg(label = "[[SessionDemo.name.label]]")
 @NotEmpty
 String name) {
  if (!sessionMap.containsKey(name))
   sessionMap.put(name, "Some Value");
 }

 // Ensure that a public setter exists.
 public void setSessionMap(Map<String, Object> sessionMap) {
  this.sessionMap = sessionMap;
 }
}

Set a session variable
The below example shows how to develop an action (for example, Set session variable). In the
action, the session details are retrieved and stored as a session variable so that the information can be
used within a specific package.

@BotCommand
@CommandPkg(label = "[[SessionDemo2.label]]", description =
 "[[SessionDemo2.description]]", icon = "sample.svg", name = "SessionDemo2",
return_type = DataType.STRING)
public class SessionDemo2 {

 // Sessions are provided as a Map. Actions can add or remove entries in
 this
 // Map.
 // The choice to reuse/overwrite/delete/add any Object in this Map belongs
 to
 // the actions, and the framework makes no assumption regarding it.
 @Sessions
 private Map<String, Object> sessionMap;

 @Execute
 public Value<?> execute(@Idx(index = "1", type = TEXT)
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 @Pkg(label = "[[SessionDemo2.name.label]]")
 @NotEmpty
 String name) {
  if (sessionMap.containsKey(name)) {
   return new StringValue(sessionMap.get(name));
  } 
  return new StringValue("session does not exist");
 }
 // Ensure that a public setter exists.
 public void setSessionMap(Map<String, Object> sessionMap) {
  this.sessionMap = sessionMap;
 }
}

Concetti correlati
How to examples alla pagina 2375
This section contains code examples and explanations about how to code some basic bot capabilities.

Configure shared session using Package SDK
Package SDK provides configuration for the SDK users to create and use shared sessions. Sessions are
seamlessly shared between different bots to share resources between them. This means that if a session
has been created, the other TaskBots can read and update the session and vice versa.

Share session between parent and child

The following section describes creating a shared session. The parent GlobalSessionDemoUpperCaseParent
returns a Session value to the global session and is used by the child bot GlobalSessionDemoUpperCaseChild.

Nota:  Place the three classes below in the following location: <PackageSDK>\src\main\java\com
\automationanywhere\botcommand\samples\commands\basic

1. Create the following POJO class DemoForSession that implements CloseableSessionObject.

package
 com.automationanywhere.botcommand.samples.commands.basic.GlobalSessionSampleProject;

import
 com.automationanywhere.toolchain.runtime.session.CloseableSessionObject;

import java.io.IOException;

public class DemoForSession implements CloseableSessionObject
{
    public void setClose(boolean close) {
        this.close = close;
    }

    boolean close=false;
    public String getDemo() {
        return demo;
    }

    public void setDemo(String demo) {
        this.demo = demo;
    }
    public DemoForSession(String demo){
        this.demo=demo;
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    }
    String demo;

    @Override
    public boolean isClosed() {
        return close;
    }

    @Override
    public void close() throws IOException {

    }
}

2. Add the @BotCommand annotation to make a class as an Action in the Control Room. For more
information on annotations, see Annotations alla pagina 2412.

@BotCommand

3. Add the @CommandPkg annotation to define all the UI related components - labels, description , icon,
return_type, and name. The elements return_label, return_settings, return_type, and return_required
belonging to the @CommandPkg ensures that the SESSION is returned by the parent bot.

@CommandPkg(
  //Unique name inside a package and label to display.
  name = "GlobalSession", label = "Global session uppercase parent",
  node_label = "Shared session parent node label", description = "Shared
 session parent description", icon = "pkg.svg",
  
  //Return type information. return_type ensures only the right kind of
 variable is provided on the UI. 
  return_label = "Return the parent session",
  return_settings = {ReturnSettingsType.SESSION_TARGET},
  return_type = SESSION,
  return_required = true)

4. Create the GlobalSessionDemoUpperCaseParent object. The GlobalSessionDemoUpperCaseParent gets a
lower case string input from the action's input, converts it to an upper case string and store the result
in the SessionValue.
• Annotate the method with @Execute to execute the method during compilation.

package
 com.automationanywhere.botcommand.samples.commands.basic.GlobalSessionSampleProject;

import com.automationanywhere.botcommand.data.impl.SessionValue;
import com.automationanywhere.commandsdk.annotations.*;
import com.automationanywhere.commandsdk.annotations.rules.NotEmpty;
import com.automationanywhere.commandsdk.model.ReturnSettingsType;
import org.apache.logging.log4j.LogManager;
import org.apache.logging.log4j.Logger;

import java.util.Map;

import static
 com.automationanywhere.commandsdk.model.AttributeType.TEXT;
import static com.automationanywhere.commandsdk.model.DataType.SESSION;

//BotCommand makes a class eligible for being considered as an action.
@BotCommand
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//CommandPks adds required information to be dispalable on GUI.
@CommandPkg(
  //Unique name inside a package and label to display.
  name = "GlobalSession", label = "Global session uppercase parent",
  node_label = "Shared session parent node label", description =
 "Shared session parent description", icon = "pkg.svg",
  
  //Return type information. return_type ensures only the right kind of
 variable is provided on the UI. 
  return_label = "Return the parent session",
  return_settings = {ReturnSettingsType.SESSION_TARGET},
  return_type = SESSION,
  return_required = true)
public class GlobalSessionDemoForStringUpperCaseParent {
 private static Logger logger =
 LogManager.getLogger(GlobalSessionDemoForStringUpperCaseParent.class);

 //Identify the entry point for the action. Returns a SessionValue
 because the return_type is SESSION. 
 @Execute
 public SessionValue action(
   //Idx 1 would be displayed first, with a text box for entering the
 value.
   @Idx(index = "1", type = TEXT) 
   //UI labels.
   @Pkg(label = "Enter string in lower case")
   //Ensure that a validation error is thrown when the value is null.
   @NotEmpty 
   String firstString) {
  String result = firstString.toUpperCase();
  DemoForSession demoForSession= new DemoForSession(result);
  return SessionValue
    .builder()
    .withSessionObject(demoForSession)
    .build();
 }
}

5. Create the GlobalSessionDemoUpperCaseChild object. The GlobalSessionDemoUpperCaseChild gets a
lower case string input from the action's input, converts it to upper case and concatenates it with the
SessionValue received from the parent bot.

package
 com.automationanywhere.botcommand.samples.commands.basic.GlobalSessionSampleProject;

import com.automationanywhere.botcommand.data.Value;
import com.automationanywhere.botcommand.data.impl.StringValue;
import
 com.automationanywhere.botcommand.samples.commands.basic.Uppercase;
import com.automationanywhere.commandsdk.annotations.*;
import com.automationanywhere.commandsdk.annotations.rules.NotEmpty;
import com.automationanywhere.commandsdk.annotations.rules.SessionObject;
import com.automationanywhere.commandsdk.model.AttributeType;
import com.automationanywhere.commandsdk.model.DataType;
import org.apache.logging.log4j.LogManager;
import org.apache.logging.log4j.Logger;

import static com.automationanywhere.commandsdk.model.AttributeType.TEXT;
import static com.automationanywhere.commandsdk.model.DataType.STRING;

//BotCommand makes a class eligible for being considered as an action.
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@BotCommand

//CommandPks adds required information to be dispalable on GUI.
@CommandPkg(
  //Unique name inside a package and label to display.
  name = "GlobalSessionChild", label = "Global session upper case child",
  node_label = "Global session child node label",
  description = "Global session child description", icon = "pkg.svg",
  
  //Return type information. return_type ensures only the right kind of
 variable is provided on the UI. 
  return_label = "Return the concatenated string to", return_type =
 STRING, return_required = true)
public class GlobalSessionDemoUpperCaseChild {
 private static Logger logger = LogManager.getLogger(Uppercase.class);
 
 @Execute
 public Value<String> action(
   //Idx 1 would be displayed first, with a text box for entering the
 value.
   @Idx(index = "1", type = TEXT) 
   //UI labels.
   @Pkg(label = "Enter a sting in lower case to concatenate")
   //Ensure that a validation error is thrown when the value is null.
   @NotEmpty 
   String sourceString,
   @Idx(index = "2", type = AttributeType.SESSION)
   @Pkg(label = "sharedSession", description = "sharedSession",
     default_value = "Default", default_value_type = DataType.SESSION)
   //Using the sessionObject annotation here as its a consumer class
     @SessionObject
     DemoForSession session) {

  //Business logic
  String result = sourceString.toUpperCase();
  logger.info("session: {}",session);
  return new StringValue(result+session.getDemo().toUpperCase());
 }
}

6. Build and upload the custom package to the Control Room. For more information on uploading the
package, see Using the package SDK alla pagina 2370.

7. Create a bot by using the Global session uppercase parent action.
a. Enter a lower case string (For example: parentbot string)
b. Enter a name for the session. The parent bot returns the value to the Global session (For

example: Global)

8. Create a TaskBots by using the Global session upper case child action. You will be able to input a
lower case string and also get the string from the shared parent session. Concatenate the parent and
child strings.
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9. Use a Message box to show the output.
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10. Now call the Global session upper case child into the parent.

11. Run the parent bot and you will see the message box showing the value from the Child bot which it
derived using the Shared global session.

Creare bots per condividere i dettagli della sessione utilizzando il pacchetto SDK
A shared session enables you to reuse actions between TaskBots that run concurrently, for example, using
the same Excel file to pass values.
Assicurati di disporre di quanto segue per creare un TaskBot:
• Accesso a Control Room
• Credenziali con autorizzazioni AAE_Basic
• Una licenza di sviluppo, che consenta di creare ed eseguire TaskBots
• La tua postazione di lavoro è un dispositivo registrato nella Control Room
• Un file Excel che si desidera utilizzare nelle azioni della sessione condivisa

1. Accedi a Control Room.
2. Crea tre TaskBots che condivideranno le azioni della sessione condivisa.
3. Create a new childSession2 variable of Type > Session and Session type > MS Excel session,

select Use as input, and then click Apply.
4. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
5. Click the Create a bot icon.
6. Crea un nuovo bot denominato childBot2.

a) Nel campo Nome, immetti childBot2.
b) In the Actions pane, find Excel Advanced, and drag Get current worksheet name to the Bot

editor.
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c) In Session name > Shared session, enter F2 > childSession2, and in Assign the output
to variable, select prompt-assignment.

7. Create a new parentSession variable of Type > Session and Session type > MS Excel session, and
then click Apply.

8. Crea un nuovo bot denominato parentSession, quindi fai clic su Crea e modifica.
9. Nel riquadro Azioni, trova Excel avanzato e trascina Apri su Bot editor.

a) In Percorso file, seleziona File desktop, fai clic su Sfoglia e seleziona il file Excel che si
desidera utilizzare.

b) In Nome sessione, mantieni Predefinito.
c) Fai clic su Salva.

10. Create a new childSession1 variable of Type > Session and Session type > MS Excel session,
select Use as input, and then click Apply.

11. Crea un nuovo bot denominato childBot1.
a) Nel campo Nome, immetti childBot1.
b) In the Actions pane, find Excel Advanced, and drag Get single cell to the Bot editor.
c) Seleziona Cella attiva in Nome sessione, quindi seleziona Nome locale, immetti F2, quindi in

Archivia contenuto cella in, seleziona prompt-assignment.

12. Nel riquadro Azioni, trova Excel avanzato e trascina Imposta variabile di sessione su Bot editor.
a) In Nome sessione, mantieni Predefinito.
b) In Salva sessione in una variabile, seleziona parentSession.

13. Dal riquadro Azioni, trova TaskBot e trascina Esegui su Bot editor.
a) In TaskBot da eseguire, seleziona File della Control Room, fai clic su Scegli, quindi su

Sfoglia e seleziona childBot1.
b) In Valori di input, seleziona Imposta childSession1, immetti F2, quindi seleziona

parentSession.

14. Nel riquadro Azioni, trova Excel avanzato e trascina Chiudi, seleziona Nome sessione come
Nome locale, quindi mantieni Predefinito.

15. Nel riquadro Azioni, trova la Finestra di messaggio. In Inserisci il messaggio da mostrare,
immetti F2, quindi seleziona prompt-assignment.

16. Nel riquadro Azioni, seleziona TaskBot e trascina Esegui su Bot editor.
a) In TaskBot da eseguire, seleziona File Control Room, fai clic su Scegli, quindi su Sfoglia,

poi seleziona childBot2.
b) In Valori di input, seleziona Imposta childSession2, immetti F2, quindi seleziona

childSession1.

17. Nel riquadro Azioni, trova la Finestra di messaggio. In Inserisci il messaggio da mostrare,
immetti F2 e seleziona prompt-assignment.

18. Salva tutti e tre i bots ed esegui parentSession TaskBot.

Vengono visualizzati i seguenti tre messaggi di errore:
Valore cella singola da bot padre:1
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Nome del foglio di lavoro corrente di Excel aperto nel bot padre:Foglio1 <nome
del foglio>

Il bot è stato eseguito correttamente!

Concetti correlati
How to examples alla pagina 2375
This section contains code examples and explanations about how to code some basic bot capabilities.

Annotations
This section provides reference information about the annotations used to create Automation Anywhere
packages.
• Creation and function annotations alla pagina 2412

List of the available creation and function annotations.
• Validation annotations alla pagina 2415

Validates annotated strings and values used in the Java code.
• Configurare e utilizzare le credenziali per consentire l'annotazione della password alla pagina 2416

Utilizza il file del pacchetto SDK CredentialTypeDemo.java fornito e configura l'annotazione
CredentialAllowPassword per il campo password nelle azioni locker Automation 360.

Concetti correlati
Standard coding practices and guidelines for developing packages alla pagina 2367
This topic covers standard coding practices and guidelines that help to ensure the development of high
quality packages.
How to examples alla pagina 2375
This section contains code examples and explanations about how to code some basic bot capabilities.
Attività correlate
Set up the Java project alla pagina 2366
Set up an integrated development environment (IDE) for Java, including Automation Anywhere custom
annotations to develop an action package that you can upload to your Control Room.
Develop a sample package alla pagina 2369
Develop your own package and upload it to an Control Room to provide custom actions for bots.

Creation and function annotations
List of the available creation and function annotations.

Annotation: BotCommand

Makes the type eligible to be treated as an action. You can define three types of actions commandType
property.
• Command\Action
• Condizione
• Iteratore

Examples:
• @BotCommand(commandType = BotCommand.CommandType.Iterator)
• @BotCommand(commandType = Condition)
• @BotCommand(commandType = Varialbe)
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• @BotCommand(commandType = Trigger)

Annotation: CommandPkg

Makes the type eligible for creation of action package.json. This annotation must be used with
BotCommand to take effect.Pkg participates in the activity only when this annotation is present.
Esempio:

@CommandPkg(label = "Create", name = "createFile", 
description = "Creates a file", node_label = "{{filePath}}", 
icon = "file.svg")

Annotation: ConditionTest

Participates in the Condition execution. This annotation can only be used when the BotCommand
has commandType set as Condition. Only one method needs to be annotated when BotCommand
annotation is present on the type. Failure to do so will result in the compilation error.

Annotation: Esegui

Participates in the execution of BotCommand. Exactly one method needs to be annotated when
BotCommand annotation is present on the type. Failure to do so will result in the compilation error.
Esempio:

@Execute public void create( @Idx(index = "1", type = FILE) @LocalFile
 @Pkg(label = 
"File", description = "e.g. C:\\MyDoc\\MyFile.doc") @NotEmpty String
 filePath, 
@Idx(index = "2", type = CHECKBOX) @Pkg(label = "Overwrite an existing
 file") 
@NotEmpty Boolean isOverwrite) { createFile(filePath, isOverwrite); }

Annotation: GlobalSessionContext

Can only be applied to member variables and fetches the GlobalSessionContext through a setter.
Esempio:

@com.automationanywhere.commandsdk.annotations.GlobalSessionContext
    private GlobalSessionContext globalSessionContext;

    public void setSessionMap(Map < String, Object > sessionMap) {
     this.sessionMap = sessionMap;
    }
    public void
 setGlobalSessionContext(com.automationanywhere.bot.service.GlobalSessionContext
 globalSessionContext) {
     this.globalSessionContext = globalSessionContext;
    }
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Annotation: HasNext

Participates in the execution of Iterator. This annotation can only be used when the BotCommand
has commandType set as Iterator. Requires the Next annotation to be present. One method needs
to be annotated when BotCommand annotation is present on the type. Failure to do so will result in the
compilation error.

Annotation: Indice

Makes the annotated element part of hierarchy utilized for the code and resource generation. Without this
annotation no BotCommand related element annotations would be processed.

Annotation: Idx.Option

An option represents the elements that would play in the hierarchy, but lend the values to the parents.
Examples:
• RADIO

@Idx(index = "1", type = RADIO, options = {
    @Idx.Option(index = "1.1", pkg = @Pkg(node_label
 = "[[Delay.delayType.1.1.node_label]]", label =
 "[[Delay.delayType.1.1.label]]", value = REGULAR)),
    @Idx.Option(index = "1.2", pkg = @Pkg(node_label
 = "[[Delay.delayType.1.2.node_label]]", label =
 "[[Delay.delayType.1.2.label]]", value = RANDOM))
})
@Pkg(label = "[[Delay.delayType.label]]", default_value = "REGULAR",
 default_value_type = DataType.STRING)
@Inject
private String delayType;

• SELECT

@Idx(index = "2", type = SELECT, options = {
@Idx.Option(index = "2.1", pkg = @Pkg(label =
 "[[LaunchWebsite.browser.2.1.label]]", value = "DEFAULT")),
@Idx.Option(index = "2.2", pkg = @Pkg(label =
 "[[LaunchWebsite.browser.2.2.label]]", value = "INTERNET_EXPLORER")),
@Idx.Option(index = "2.3", pkg = @Pkg(label =
 "[[LaunchWebsite.browser.2.3.label]]", value = "FIREFOX")),
@Idx.Option(index = "2.4", pkg = @Pkg(label =
 "[[LaunchWebsite.browser.2.4.label]]", value = "CHROME"))
}) @Pkg(label = "[[LaunchWebsite.browser.label]]", default_value =
 "DEFAULT", default_value_type = DataType.STRING) @NotEmptyStringbrowser)

Annotation: Inject

Makes an element eligible for injection into the annotated type object. The injection is setter-based so
a corresponding setter in the type is mandatory. The injected values would form the BotCommand
parameter map using the name provided in Idx.
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Annotation: Avanti

Participates in the Iterator execution. This annotation can only be used when the BotCommand has
commandType set as Iterator. Requires the HasNext annotation to be present. One method needs
to be annotated when BotCommand annotation is present on the type. Failure to do so will result in
compilation error.

Annotation: Pkg

Makes an element to participate in the package.json creation. This annotation is ignored when Idx is
not present.
Concetti correlati
Annotations alla pagina 2412
This section provides reference information about the annotations used to create Automation Anywhere
packages.

Validation annotations
Validates annotated strings and values used in the Java code.

Annotazione Descrizione

CodeType The MIME-type of the code to format.

CredentialOnly Can only accept a credential value, no string
allowed.

Equals Validates that the given string is equal to the
annotated string variable.

FileExtension Validates the annotated string value that ends
with the supported extension type.

GreaterThan Validates that the annotated number variable
value is always greater than the given numeric
value.

GreaterThanEqualTo Validates that the annotated number variable
value is always greater than or equal to the
given numeric value.

LessThan Validates that the annotated number variable
value is always less than the given numeric
value.

LessThanEqualTo Validates that the annotated number variable
value is always less than or equal to the given
numeric value.

LocalFile Can only accept local paths and no file
expression.

MatchesRegex Validates that the annotated string value
matches the given regular expression.
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Annotazione Descrizione

NotEmpty Validates and throws an exception when the
annotated variable value is null.

@Execute
public
 Value<Double>length(@Idx(index="1",
    type=TEXT)@Pkg(label="Source
 string")@NotEmpty String 
    sourceString){}

NotEquals Validates that the given string is not be equal to
the annotated string variable.

NotMatchesRegex Validates that the annotated string value does
not match the given regular expression.

NumberInteger Ensures the UI accepts only integers and not
double for the annotated variable value.

RepositoryFile Can only accept repository paths and no file
expression.

VariableNotPackage Cannot choose a variable from this package.

VariablePackage Can only choose a variable from this package.

VariableSubType The variable subtype must match.

VariableType The variable type must match.

VariableUserDefined Can only choose a user-defined variable.

Concetti correlati
Annotations alla pagina 2412
This section provides reference information about the annotations used to create Automation Anywhere
packages.

Configurare e utilizzare le credenziali per consentire l'annotazione della password
Utilizza il file del pacchetto SDK CredentialTypeDemo.java fornito e configura l'annotazione
CredentialAllowPassword per il campo password nelle azioni locker Automation 360.
Esempio:Esamina CredentialTypeDemo.java
Utilizza il seguente file CredentialTypeDemo.java disponibile in: <latest package-
sdk>2.0.9\src\main\java\com\automationanywhere\botcommand\samples\commands
\basic\types come esempio per come configurare l'attributo delle credenziali.

@BotCommand
@CommandPkg(label = "[[CredentialTypeDemo.label]]", 
description = "[[CredentialTypeDemo.description]]", icon = "sample.svg",
 name = "credentialTypeDemo")
public class CredentialTypeDemo {

 private static Logger logger =
 LogManager.getLogger(CredentialTypeDemo.class);

 /**
  * To accept credentials the {@link AttributeType} in index should be
  * {@link AttributeType.CREDENTIAL CREDENTIAL}. A {@link SecureString} is
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  * provided for any credentials type.
  */
 @Execute
 public void printCredentials(@Idx(index = "1", type =
 AttributeType.CREDENTIAL)
 @Pkg(label = "[[CredentialTypeDemo.credentials.label]]")
 SecureString credentials) {
  // SecureString provides multiple way to access the data inside.
  // Let's try to get the user name and print it in logs.

  // To get the username as String
  String userName = credentials.getInsecureString();
  logger.trace("User name from getInsecureString : {}", userName);

Esempio: Configurare gli attributi della credenziale @Esegui
Configure the index, type, label, optional description, and the credentialAllowPasswordAttribute.
Quando si crea un pacchetto nuovo o si aggiorna un pacchetto esistente, utilizza l'annotazione
CredentialAllowPassword per consentire al selezionatore delle credenziali di scegliere un attributo di
credenziale contrassegnato come campo della password.

@Execute
 public void printCredentials(@Idx(index = "2", type =
 AttributeType.CREDENTIAL)
 @Pkg(label =
 "[[CredentialTypeDemo.credentialsAllowPasswordAttribute.label]]")
 @CredentialAllowPassword SecureString credentialAllowPasswordAttribute) {

Configure the attributes in theControl Room
Nel campo Nome attributo, immetti la password e una descrizione facoltativa, nel campo Input,
seleziona Standard, quindi immetti il Valore. Nel campo Sicurezza, seleziona Usa l'attributo solo nei
campi Password o Mascherato.

Use the credential attribute inControl Room
• Nel campo Seleziona credenziali, seleziona Credenziale. Nel campo Attributo, seleziona Nome

utente. Nel campo Fornisci le credenziali per l'utente (facoltativo), seleziona Credenziale,
quindi Seleziona.

• Nel campo Attributo, seleziona Password. Nel campo Fornisci le credenziali per la password
(facoltativo), seleziona Credenziale, quindi Seleziona.

Build and test a demo package and bot
This practical how to section demonstrates that creating, changing, and managing packages allow you to
customize actions and efficiently manage packages for all Control Room users.
Here is a list of all the necessary tasks to create a package, add the package to your Control Room, and
verify your work in a bot. Complete the listed tasks in order.

Suggerimento:  Click the title of each step to go the detailed task.

Step 1 Update related workflow and build files alla
pagina 2418

Follow the detailed steps for updating workflow
and build files for this project using your integrated
development environment (IDE).
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Step 2 Choose your favorite IDE You can compile a package from the IDE of your
choice. Here are two possible ways you can compile
a package:

Compile a demo JAR file
from the Eclipse UI alla
pagina 2419

Use Eclipse to compile a
demo JAR file that you
can add as a package to
your Control Room.

Compile a demo JAR file
from the command line
alla pagina 2419

Compile the demo Java
code provided with this
software development
kit.

Step 3 Add your demo package to the Control Room
alla pagina 2420

Users with Upload package permission can add
packages to the Control Room for use by all Bot
Creators.

Step 4 Create a demo bot with the demo package alla
pagina 2421

Create a bot using the demo package to verify the
actions that were created.

Step 5 Change the Java file used to create the package
JAR file alla pagina 2421

Modify and compile the Java code used to create a
package to fix issues and create new functionality.

Step 6 Upload new demo package alla pagina
2422

Package management allows you to upload package
updates. The new package has the same name, but
a different version number.

Step 7 Update the demo bot with the updated package
alla pagina 2422

Update bots to use specific package versions.

Update related workflow and build files
Follow the detailed steps for updating workflow and build files for this project using your integrated
development environment (IDE).
Complete all the steps for project setup detailed in Set up the Java project alla pagina 2366.
This task shows you how to update the appropriate build and workflow files.
1. Open the project "A2019DemoPakcage" that you created in Set up the Java project alla pagina 2366.

You can find the project file in the directory where you extract the zip files to, for example c:
\A2019DemoPackage.

2. From inside the project, Open the settings.gradle file.
3. Replace the project name with A2019DemoPackageFirstnameLastname.

If your name is John Developer it would look like this, A2019DemoPackageJohnDeveloper.
4. Open src > main > resources > package.template.
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5. Update the name, label, and description values.

Original package.template Updated package.template

{
  "name": "A2019DemoPackage",
  "label": "A2019DemoPackage",
  "description": "Provides
 actions for A2019DemoPackage
 operations.",
  "group": "",
  "artifactName": "",
  "packageVersion": "",
  "codeVersion": "",
  "commands": []
}

{
  "name":
 "A2019DemoPackageFirstnameLastname",
  "label":
 "A2019DemoPackageFirstnameLastname",
  "description":
 "A2019DemoPackageFirstnameLastname",
  "group": "",
  "artifactName": "",
  "packageVersion": "",
  "codeVersion": "",
  "commands": []
}

6. Salva le modifiche.

After you have setup the build files, you need to compile the demo Java code, Compile a demo JAR file from
the command line alla pagina 2419.

Compile a demo JAR file from the Eclipse UI
Use Eclipse to compile a demo JAR file that you can add as a package to your Control Room.
Before starting this task complete the steps in Update related workflow and build files alla pagina 2418.
Build a package file using a Gradle project in the Eclipse IDE.
1. Import the A2019DemoPackage as a Gradle project, File > Import > Gradle > Existing Gradle

Project and click Finish.
2. From the Gradle Tasks tab, go to <your project> > build and run the following tasks in order.

a) <your project> > build > clean
b) <your project> > build > build

3. From the Gradle Tasks tab, go to <your project. > shadow and run the shadowJar task.
Your compiled package file is located in file:\ \A2019DemoPackage\build\libs\. The package file
has named after your project name (<your project>-1.0.0.jar).

To add your custom package to your Control Room follow the instructions in Add packages to the Control
Room alla pagina 2649.
Concetti correlati
Build and test a demo package and bot alla pagina 2417
This practical how to section demonstrates that creating, changing, and managing packages allow you to
customize actions and efficiently manage packages for all Control Room users.

Compile a demo JAR file from the command line
Compile the demo Java code provided with this software development kit.
Before starting this task complete the steps in Update related workflow and build files alla pagina 2418.
1. Open a terminal window and go to where the gradlew.bat file is located.

...\A2019DemoPackage > gradlew.bat
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2. In the terminal window, type gradlew.bat clean build shadowJar, and press Enter. Here is
an example of what you see:

> . . .\A2019DemoPackage>gradlew.bat clean build shadowJar

> Task :compileJava
Note: Starting hierarchy discovery for
 'com.automationanywhere.botcommand.demo.Concatenate'
Note: Starting non-hierarchical element discovery for
 'com.automationanywhere.botcommand.demo.Concatenate'
Note: Starting hierarchy discovery for
 'com.automationanywhere.botcommand.demo.Uppercase'
Note: Starting non-hierarchical element discovery for
 'com.automationanywhere.botcommand.demo.Uppercase'
Note: Starting Command Java generator...
Note: Starting Json generator...
Note: Generating command json for Concatenate
Note: Generating command json for Uppercase

> Task :commandCodeGen
mergeJsonFiles: updatePackage: group com.automationanywhere ,
 artifactName A2019DemoPackageFirstnameLastname , 
packageVersion 1.0.0-20190816-101906

The compiled file is located in file:\ \A2019DemoPackage\build\libs\.

To add your custom package to your Control Room follow the instructions in Add packages to the Control
Room alla pagina 2649.
Concetti correlati
Build and test a demo package and bot alla pagina 2417
This practical how to section demonstrates that creating, changing, and managing packages allow you to
customize actions and efficiently manage packages for all Control Room users.

Add your demo package to the Control Room
Users with Upload package permission can add packages to the Control Room for use by all Bot
Creators.
Before you can upload a package, you need valid user login credentials with Upload package permission
for the Control Room you are adding the package to.
To add a package from a source other than Bot Store, follow these steps:
1. Naviga su Gestisci > Pacchetti.
2. Click Add package.
3. Fai clic su Sfoglia.
4. Locate and select the package to add to the Control Room.

Packages are Java Archive (JAR) files that contain actions used to create bots.
5. Click Upload package.
6. On the Bots > Packages > Confirm package page, choose any of the following options:

• Accept, enable and set as default: Uploads and enables the selected package, and sets it to
the default package for the Control Room.

• Accept and enable: Uploads and enables the package, but the package is not set as the default
package. Bot Creators have to specifically select non-default packages to use them for creating
bots.

• Accept but disable: Uploads and disables the new package.

Choosing Reject stops the upload process.
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To add a package from Bot Store, see the following video:

7. After installation, click Administration > Packages to verify that the package is added.
When you add or update a package in the Control Room, a notification is also sent through the
Notifications icon. This notification is sent to the Control Room users who have the View package
permission. For more information, see Add or update package alla pagina 2925 event notification.

After successfully uploading your demo package, create a bot to test the actions you just created. For
detailed step about how to create a bot, read Create a demo bot with the demo package alla pagina 2421

Create a demo bot with the demo package
Create a bot using the demo package to verify the actions that were created.
Here are the minimum prerequisites for building this demo bot:
• Access to a Control Room
• User credentials with AAE_Basic permission
• Your local host (workstation) is a registered device in the Control Room
• Ensure that the demo package A2019DemoPackageFirstnameLastname is available in the Control

Room

This task uses the following actions and components:
• Uppercase (demo package)
• Message box
• Variables overview alla pagina 2022

1. Nel pannello di sinistra, fai clic su Automazione.
Viene visualizzato un elenco dei moduli e dei  disponibili.

2. Click the My Task Bot icon.
3. Type MyDemoBot1 in the Name field.
4. Click Create & Edit.
5. Expand A2019DemoPackageFirstnameLastname and double Uppercase.
6. Type hello world, go be great! in all lower case letters.
7. Create the variable vMyDemoVar1.
8. Fai clic su Applica.
9. Add a Message box and insert the variable vMyDemoVar1 in the Enter the message to display

field.
10. Click Apply and Save.
11. Click the Run icon.

A message box with "HELLO WORLD, GO BE GREAT!" in all upper case letters is displayed. The
custom action Uppercase converted all the letters from lower case letters to upper case letters.

The task, Change the Java file used to create the package JAR file alla pagina 2421, gives instruction on how to
modify the Uppercase action to convert all upper case letters to lower case letters.

Change the Java file used to create the package JAR file
Modify and compile the Java code used to create a package to fix issues and create new functionality.

1. Open the project "A2019DemoPakcage."
2. From inside the project, open src/main/java/

com.automationanywhere.botcommand.samples.commands/basic/Uppercase .
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3. Change the function from upper case to lower case.

Original function Updated function

String result =
 "ALL".equals(caseType) ? 
   
 sourceString.toUpperCase() :
 (sourceString
    .substring(0,
 1).toUpperCase() +
 sourceString
    .substring(1));

String result =
 "ALL".equals(caseType) ? 
   
 sourceString.toLowerCase() :
 (sourceString
    .substring(0,
 1).toUpperCase() +
 sourceString
    .substring(1));

4. Save the changes and re-compile the package.

You can now upload the changed package to the Control Room. Upload new demo package alla pagina 2422
Attività correlate
Upload new demo package alla pagina 2422
Package management allows you to upload package updates. The new package has the same name, but a
different version number.

Upload new demo package
Package management allows you to upload package updates. The new package has the same name, but a
different version number.
You need AAE_Basic permissions to create and edit bots.
1. From the Bots > Packages page, click the Add package icon.
2. Browse to the location of the package to add.

Packages are Java Archive (JAR) files that contain actions used to create bots.
3. Select the package to add, and click Upload package.
4. On the Bots > Packages > Confirm package page, click Accept, enable and set as default.

You can select specific packages to be used from within a bot. Read detailed steps about managing
packages for specific bots in Update the demo bot with the updated package alla pagina 2422 task.

Update the demo bot with the updated package
Update bots to use specific package versions.
• Access to the bot created in the task Create a demo bot with the demo package alla pagina 2421.
• AAE_Basic permission.

1. Nel pannello di sinistra, fai clic su Automazione.
Viene visualizzato un elenco dei moduli e dei  disponibili.

2. Double-click MyDemoBot1, the demo bot you created in an earlier task.
3. Click the vertical eclipses in the upper right corner and click Packages.
4. Expand the row for the package A2019DemoPackageFirstnameLastname.
5. From the drop-down list of package versions, select the Default version.

Because you added the updated package as the default version, you are selecting the new version of
the package you created.

6. Click Change Version and Save.
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7. Nel pannello di sinistra, fai clic su Automazione.
Viene visualizzato un elenco dei moduli e dei  disponibili.

8. Double-click MyDemoBot1.
9. Click A2019DemoPackageFirstnameLastname and type HELLO WORLD, GO BE GREAT! in the

Source string field.
10. Click Apply and Save.
11. Click the Run icon.

The message box displayed by the bot displays "hello world, go be great!" This verifies that the action
from the updated package is being used.

Build and test a custom package
Utilizza IntelliJ per creare un pacchetto personalizzato e utilizza le azioni Automation 360 per testare il
pacchetto.
Complete the following tasks to create a custom package, upload the package to your Control Room, and
build a bot to test it. After you update the IntelliJ files, create directories, and create and update java
classes, you can build the custom package.
1. Build a custom package in IntelliJ alla pagina 2423

Use IntelliJ to import the Automation Anywhere SDK, create a new package, and compile a JAR file
that you can upload to your Control Room.

2. Add custom package to your Control Room alla pagina 2434
Use the compiled JAR file and upload it to the Control Room.

3. Create a bot to test the custom package alla pagina 2434
Use Automation 360 actions to create a bot to test the custom package.

Nota:  The customer support team does not provide guidance for the code written by customers.

Nota:  Create custom packages

Build a custom package in IntelliJ
Use Java IntelliJ to create and compile a JAR file that you can upload as a package to your Control Room in
Automation 360.
A basic understanding of JDK and Java IntelliJ is required in order to build an action package. Ensure you
have installed the following software and files:
• Java SE Development Kit 11 Downloads
• Java IDE Community edition of IntelliJ

1. Download the latest release of the Automation Anywhere Package SDK. For the latest release of the
Package SDK, see - Automation 360 Package SDK Release Notes alla pagina 709.

2. Unzip the contents of the SDK package to any of your local directory.
3. Rename the folder from A360-package-sdk-<version number> to MetricToImperial.
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4. In IntelliJ IDEA, go to File > Open and open the project at C:\<SavedLocation>
\MetricToImperial.
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5. Open the settings.gradle file in the project root. Set the rootProject.name =
 'MetricToImperial'

6. Open the package.template file located at src > main > resources > package.template.
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7. Change the package name from A360DemoPackage to MetricToImperial.

Click the Sync button in IntelliJ to update the project.
8. Update the package name in locales json: go to src > main > resources > locales >

en_US.json.
a) Open the en_US.json file and update the required label field from A360DemoPackage to

MetricToImperial. Update the optional description.
b) Delete all other remaining lines in the en_US.json file.

9. Delete the sample packages, go to src > main > java >
com.automationanyhwere.botcommand, and delete the samples.commands and delete the
samples packages.

10. Create a new package, right-click on java folder and select New > Package. Enter the new package
name as metrictoimperial.commands.

11. Create a new Java Class, right-click on the metrictoimperial.commands package, and select
New > Java Class. Enter the name for the new class CMtoINCH:
a) Open the CMtoINCH class. Copy and paste the following code above the class definition

statement:

import static com.automationanywhere.commandsdk.model.DataType.NUMBER;
//BotCommand makes a class eligible for being considered as an action.
@BotCommand
//CommandPks adds required information to be dispalable on GUI.
@CommandPkg(
        //Unique name inside a package and label to display.
        name = "CMtoInch", label = "[[CMtoINCH.label]]",

© 2023 Automation Anywhere. All rights reserved.     2426



    Automation Anywhere - Crea

        node_label = "[[CMtoINCH.node_label]]",  description =
 "[[CMtoINCH.description]]", icon = "ruler_icon.svg",
        //Return type information. return_type ensures only the right
 kind of variable is provided on the UI.
        return_label = "[[CMtoINCH.return_label]]", return_type =
 NUMBER, return_required = true)

b) Inside the CMtoINCH class, copy and paste the following code:

//Identify the entry point for the action. Returns a Value<String>
 because the return type is String.
@Execute
public NumberValue action(
        //Idx 1 would be displayed first, with a text box for entering
 the value.
        @Idx(index = "1", type = AttributeType.NUMBER)
        //UI labels.
        @Pkg(label = "[[CMtoINCH.CMInput.label]]")
        //Ensure that a validation error is thrown when the value is
 null.
        @NotEmpty
                Double CMInput) {
    //Internal validation, to disallow empty inputs. No null check needed
 as we have NotEmpty on CMInput.
    if ("".equals(CMInput.toString().trim()))
        throw new BotCommandException("Input of CM is required");
    Number result;
    try {
        //Conversion logic
        result = CMInput * 0.393701;
    } catch (Exception e) {
        //Throw custom error message
        throw new BotCommandException("Unable to convert " +
 CMInput.toString() + "cm to inches");
    }
    //Return NumberValue.
    return new NumberValue(result);
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    }

To import the namespaces, click the highlighted red notations and press ALT+ENTER key and select
Import which automatically imports namespaces based on the annotations and datatypes.
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12. Configure en_US.json file, go to src > main > resources > locales > en_US.json and add the
following fields after the label and description values:

"CMtoINCH.label" : "cm to inches",
"CMtoINCH.node_label": "cm to inches",
"CMtoINCH.description" : "Convert centimeters to inches",
"CMtoINCH.return_label" : "Assign the Output in Inches to a Number
 Variable",
"CMtoINCH.CMInput.label" : "Centimeters to Convert to Inches"
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13. Update the CommandPkg annotation. Download icons from Github.
a) Download ruler_icon.svg from github and right-click the image and save the image as

ruler_icon.svg.
b) Download iconwhite.svg from github, right-click the image and save the image

iconwhite.svg.
c) Copy both files into the src > main > resources > icons folder.

14. Open the build.gradle in the project root. After the dependencies section, but before the last
closing tag, copy and paste the following code:

test {
   testLogging {
      exceptionFormat = 'full'
   }
   useTestNG() {}

   afterSuite { desc, result ->
      if (!desc.parent)
         println("${result.resultType} " +
               "(${result.testCount} tests, " +
               "${result.successfulTestCount} successes, " +
               "${result.failedTestCount} failures, " +
               "${result.skippedTestCount} skipped)")
   }
   maxHeapSize "3g"
}
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15. Update the version number and remove dependencies that is not required for your project from
build.gradle.

16. Create a new directory, right-click src and select New > Directory.
a) In the Name field, enter test\java, or select the test\java suggestion from the Gradle

Source Sets.
b) Create a new package, right-click the java directory and select New > Package.
c) Enter the name for the newly created package: metrictoimperial.commands.

17. Create new Java class, right-click and select New > Java Class. Enter the name for the new class
CMtoINCHTest.
Inside the CMtoINCHTest class, copy and paste the following code:

@Test
public void testCMtoINCH(){
    Double validInput = 10.00;
    Double expectedOutput = 0.393701 * validInput;
    CMtoINCH testCM = new CMtoINCH();
    Value<Double> result = testCM.action(validInput);
    Assert.assertEquals(result.get(), expectedOutput);
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}

18. Save the project File > Save All.
19. Build the package.

You can use the IntelliJ UI or the command line. If you are using the command line:
a) Open a terminal window and navigate to the MetricToImperial directory.
b) To build the project, enter the following command: gradlew.bat clean build shadowJar

A BUILD SUCCESSFUL message appears.
Sometimes a build might fail because existing files could not be automatically deleted and a system
message appears indicating the execution failed for the task: clean. If this occurs, close the explorer
windows and run the build again.

Add custom package to your Control Room alla pagina 2434
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Add custom package to your Control Room
Use the compiled JAR file and upload it as a package to your Control Room in Automation 360.
• Completa i passaggi in Build a custom package in IntelliJ alla pagina 2423.
• Ensure you have the following:

• Access to the Control Room.
• Credentials with AAE_Basic permission or a custom role with permissions to add packages to the

Control Room.

1. From Windows Explorer, go to C:\Users\<Username>\IdeaProjects\MetricToImperial
\build\libs and locate MetricToImperial-1.0.0.jar.

2. Log in to your Control Room as a user with permissions to add a new package.
3. Click BOTS > Packages.
4. In the All packages page, move your mouse over the plus sign and click Add package.
5. In the Add package page, click Browse and locate the MetricToImperial-1.0.0.jar file.

By default, the file is located at: C:\Users\<Username>\IdeaProjects\MetricToImperial
\build\libs.

6. Select the MetricToImperial-1.0.0.jar file and click Open.
7. Click Upload Package.

When you add a custom package to the Control Room, a notification is also sent to the Control
Room users to notify about package updates. This notification is sent to the users who have the
View package permission. For more information, see Add or update package alla pagina 2925 event
notification.

Create a bot to test the custom package alla pagina 2434
Concetti correlati
Build and test a custom package alla pagina 2423
Utilizza IntelliJ per creare un pacchetto personalizzato e utilizza le azioni Automation 360 per testare il
pacchetto.
Attività correlate
Add custom package to your Control Room alla pagina 2434
Use the compiled JAR file and upload it as a package to your Control Room in Automation 360.
Create a bot to test the custom package alla pagina 2434
Use the actions in Automation 360 to create a bot and test the custom package.

Create a bot to test the custom package
Use the actions in Automation 360 to create a bot and test the custom package.
Ensure you have the following to build the bot:
• Access to the Control Room.
• Credentials with AAE_Basic permission or with a custom role to build a bot.
• Your workstation is a registered device in the Control Room.
• Your package MetricToImperial-1.0.0.jar is available in the Control Room.

1. Accedi a Control Room.
2. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
3. Click the Create a bot icon.
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4. In the Name field, enter MetricToImperialTest.
5. Click Create & Edit.
6. In the Actions pane, find Metric to Imperial and drag Convert centimeters to inches into the bot

flow.
a) In the CM to Convert field, enter 1.
b) Click Create variable (next to the Output field) to create a new number variable.
c) In Create Variable, enter nInchesOutput and click Create & Select.
d) Fai clic su Applica.

7. In the Actions pane, find the Number package and drag the To String command below Convert
centimeters to inches.
a) In the Enter a number field, enter F2 and select nInchesOutput.
b) In the Enter number of digits after decimal field, enter 5.
c) In the Assign the output to variable field, select prompt-assignment - String from the

drop-down list.
d) Fai clic su Applica.

8. From the Actions pane, drag Message box, click F2 and insert the prompt-assignment variable.
9. In the Enter the message to display field, click F2 and select the prompt-assignment variable.
10. Click Apply and Save.
11. Fai clic su Esegui.

The bot displays the 0.39370 message, which is a successful build.

Concetti correlati
Build and test a custom package alla pagina 2423
Utilizza IntelliJ per creare un pacchetto personalizzato e utilizza le azioni Automation 360 per testare il
pacchetto.
Attività correlate
Build a custom package in IntelliJ alla pagina 2423
Use Java IntelliJ to create and compile a JAR file that you can upload as a package to your Control Room in
Automation 360.
Add custom package to your Control Room alla pagina 2434
Use the compiled JAR file and upload it as a package to your Control Room in Automation 360.

Using Python to parse JSON response
Use the Automation 360 Python script to execute Python functions to build a bot. Use the Python functions
to parse the JSON response from a REST Web Services GET request.
Ensure you have the following to build the bot:
• Basic understanding of Python programming language.
• Basic experience with creating Automation Anywhere bots.

© 2023 Automation Anywhere. All rights reserved.     2435



    Automation Anywhere - Crea

• Download and install Python 3.
download Python

Do one of the following:
• While installing the Python, make sure to select Add Python x.xx to PATH during the Python

installation.

• Add a path to the Environment variable.

1. Accedi a Control Room.
2. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
3. Click Create a bot icon.

4. In the Name field, enter PythonTutorial.
5. Click Create & Edit.
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6. In the Actions pane, click Variables to create the following new variables:
a) Name dResponse, Type > Dictionary and Subtype > String.
b) Name dRetrieveValue, Type > Dictionary and Subtype > Any.
c) Name dResponseBody, Type > String.
d) Name sFullName, Type > String.
e) Name sLocation, Type > String.
f) Name sTotalUserCount, Type > String.
g) Name nTotalUserCount, Type > Number.
h) Name nCurrentUser, Type > Number.
i) Name sCurrentUser, Type > String.
j) Name prompt-assignment, Type > String.

© 2023 Automation Anywhere. All rights reserved.     2437



    Automation Anywhere - Crea

7. From the Actions pane, select REST Web Services > Get method and place it under the Start of
the bot flow.
a) In the URI field, enter https://randomuser.me/api/?results=5&inc=name,email,location&nat=us.

This is a sample API that returns random user details to the calling application.
b) In the Authentication Mode drop-down list, select No Authentication.
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c) In the Assign the output to a variable drop-down list, select dResponse -Dictionary of
Strings.
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8. From the Actions pane, click String > Assign action and drag it into the canvas below the REST
Web Services action.
a) In the Select the source string variable value field, enter $dResponse{Body}$.

b) In the Select the destination string variable drop-down list, select dResponseBody -
String.
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9. From the Actions pane, click Python script > Openand drag it into the canvas below the String >
Assignaction.
a) In the Python field, select Manual input.

b) In the Enter script here field, copy and paste the following code.

import json
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def get_node_count(response):
    #parse response as json
    response_dict=json.loads(response)
    # Create list from JSON body
    response_body = response_dict['results']
    #return the count of entries in JSON body as string
    lengthasstring = str(len(response_body))
    return lengthasstring

def get_full_name(dictRequest):
    itemCount = int(dictRequest['count'])
    #parse response as json
    response_dict=json.loads(dictRequest['response'])
    # Create list from JSON body
    response_body = response_dict['results']
    #Extract values to return
    return response_body[itemCount]['name']['first'] + " " +
 response_body[itemCount]['name']['last'] 

def get_location(dictRequest):
    itemCount = int(dictRequest['count'])
    #parse response as json
    response_dict=json.loads(dictRequest['response'])
    # Create list from JSON body
    response_body = response_dict['results']
    #Extract values to return
    return response_body[itemCount]['location']['city'] + ", " +
 response_body[itemCount]['location']['state']

c) In the Python runtime version field, retain the default value as 3.
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10. From the Actions pane, click Python script > Execute function and drag it into the canvas below
the Python script > Open action.
a) In the Python session field, retain Default.
b) In the Enter the name of function to be executed field, enter get_node_count.
c) In the Arguments to the function drop-down list, select dResponseBody - String.

d) In the Assign the output to a variable drop-down list, select sTotalUserCount - String.
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11. From the Actions pane, click Dictionary > Put and drag it into the canvas below the Python script
> Open action.
a) In the Dictionary variable field, select dRetrieveValue -Dictionary.
b) In the Associate to this key field, enter response.
c) In the New value drop-down list, select dResponseBody - String.
d) In the Assign previous value to a variable drop-down list, select prompt-assignment -

String.
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12. From the Actions pane, click String > To number and drag it into the canvas below the Dictionary
> Put action.
a) In the Enter the string field, enter $sTotalUserCount$.
b) In the Assign the output to a variable drop-down list, select nTotalUserCount - Number.
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13. From the Actions pane, click Loop > Loop.
a) In the Loop Type > Iterator, select For n times from the drop-down list.
b) In the times field, enter $nTotalUserCount$.
c) In the Assign the current value to a variable drop-down list, select nCurrentUser -

Number.
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14. From the Actions pane, click Number, select Decrement and place it inside the Loop action.
a) In the Enter number field, enter $nCurrentUser$.
b) In the Enter decrement value field, enter 1.
c) In the Assign output to a variable drop-down list, select nCurrentUser - Number.

15. From the Actions pane, click Number, select To string and place it inside of the Loop action, below
Number > Decrement.
a) In the Enter a number field, enter $nCurrentUser$.
b) In the Enter number of digits after decimal field, enter 0.
c) In the Assign output to a variable drop-down list, select sCurrentUser - String.
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16. From the Action pane, click Dictionary > Put and place it inside of the Loop action.
a) In the Dictionary variable field, select dRetrieveValue -Dictionary.
b) In the Associate to this key field, enter count.
c) In the New value drop-down list, select sCurrentUser - String.
d) In the Assign previous value to a variable drop-down list, select prompt-assignment -

String.
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17. From the Actions pane, click Python script > Execute function and place it inside of the Loop
action.
a) In the Python session field, retain Default.
b) In the Enter the name of function to be executed field, enter get_full_name.
c) In the Arguments to the function drop-down list, select dRetrieveValue - Dictionary.
d) In the Assign the output to a variable drop-down list, select sFullName - String.

© 2023 Automation Anywhere. All rights reserved.     2449



    Automation Anywhere - Crea

18. From the Actions pane, click Python script > Execute function and place it inside of the Loop
action.
a) In the Python session field, retain Default.
b) In the Enter the name of function to be executed field, enter get_location.
c) In the Arguments to the function drop-down list, select dRetrieveValue - Dictionary.
d) In the Assign the output to a variable drop-down list, select sLocation - String.
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19. From the Actions pane, click Message box and place it inside of the Loop action.
a) In the Enter the message to display field, enter the following:

Full Name: $sFullName$ Location: $sLocation$

b) Select Close message box after > Seconds, enter 5.

20. From the Actions pane, click Python script > Close and place it outside of the Loop action.
a) In the Python session field, retain Default.

21. Click Save to save your bot, and then click Run.
The bot runs, displaying five full user names with locations for approximately 5 seconds each before
completing its successful execution.

If you get a Bot Error message, see the following sections for a solution: Getting Bot Error while
executing Python Script/Function (A-People login required), Getting Bot Error or True value in message box while
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executing Python Script (A-People login required), or An unexpected error occurred while executing Python Script
command; Error code: bot.execution.error (A-People login required).

Use JavaScript to build a bot to take user input
Use the JavaScript actions Automation 360 to execute JavaScript functions to build a bot. Use the actions
to create a bot that takes user input and provides the appropriate output.
Ensure you have the following to build the bot:
• Basic understanding of JavaScript programming language.
• Basic experience with creating Automation Anywhere bots.

1. Accedi a Control Room.
2. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
3. Click Create a bot icon.
4. In the Name field, enter Hello User.
5. Click Create & Edit.
6. In the Actions pane, click Variables to create the following new variables:

a) Name lInputList, Type > List and Subtype > String.
b) Name sInputName, Type > String.
c) Name sOutput, Type > String.

7. From the Actions pane, click Prompt > For value:
a) In the Prompt window capture field, enter Enter your name here.
b) In the Prompt message field, enter Please enter your name here.
c) In the Assign the output to a variable drop-down list, select sInputName - String.

8. From the Actions pane, click List > Add item:
a) In the List variable drop-down list, select lInputList - List.
b) In the Item to be added drop-down list, select sInputName - String.
c) In the Add item field, select To end of list.

9. Create a new JavaScript file.
a) Open a notepad, and copy and paste the following code:

function response(str){
return "Hello "+ str
} 

b) Save the file in your desktop as Salutation.js, and select Save as type: as All Files.

10. From the Actions pane, click JavaScript > Open:
a) In the JavaScript session field, leave as Default.
b) In JavaScript > Import existing file, for the JavaScript file field, select Desktop file.
c) Click Browse and select the Salutation.js file from your desktop or where you saved the file.
d) In the Assign the output to a variable drop-down list, select sOutput - String.
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11. From the Actions pane, click JavaScript > Run JavaScript:
a) In the Enter name of the function to be executed field, enter response.
b) In the Parameters drop-down list, select lInputList - List.

12. From the Actions pane, click Message box:
a) In the Enter the message to display field, enter $sOutput$.

13. Click Save to save your bot, and then click Run.
14. When the bot prompts to enter a name, enter the name and click OK.

A message from the bot appears: Hello <User>.

Bot developer recommendations
Automation Anywhere provides a flexible platform for bot and package development. The information in
this topic provide guidelines and recommendations on how to structure and develop robust and reusable
bots and packages.

Bot Store submissions checklist
Use the checklist to ensure that your Automation 360 Bot Store submission is correctly created, processed,
and accepted. If you do not follow requirements listed in the checklist, your submission will be rejected
and will not be published on the Bot Store page.
Use this checklist from the developer portal: Automation 360 bot submission checklist.

Building reusable bots
Review the guidelines to gain a better understanding of how to develop bots or subtasks for reusability,
from designing and creating through reusing.

Define prerequisites, input, output, and
variables

When you build bots for reusability, define the
following:
• Document all necessary prerequisites on how to

use your bot either on its own or as a subtask.
• When creating your bots, define values as input,

output, or local. Input and output variables are
used when your bot is designed to be used as
a subtask, allowing it to receive and pass back
values to or from another calling bot.

• Provide meaningful variable descriptions when
defining input and output variables so that other
developers know how to interact with your
subtask.

• Adhere to an established standard for variable
naming guidelines. Review the Automation
Anywhere user-defined variables for variable
naming guidelines. Le tue variabili (definite
dall'utente) alla pagina 2026
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Follow single-responsibility principle Bots developed for reusability should follow
the single - responsibility principle which states
that each subtask or component should have
responsibility over a single part of the functionality
of the overall bot and that responsibility should
be entirely encapsulated by that subtask or
component.
Other examples of single-responsibility:
• A subtask that processes a single transaction,

but can be called multiple times for each
transaction on a list.

• A subtask that collects screen display data on
a single page of a website, but can be called
multiple times as a bot goes through pagination.

Bot design considerations Consider the following patterns based on which
templates must be developed for use:
1. Master, Main, and Sub bots

• Master bot: This bot is called directly to
begin the process, through mechanisms
including scheduling through the Control
Room or API call. Include the following
major process steps in the TRY section:
a. Initial setup for the process.
b. Validation that the setup was

successful. For example, check whether
all required files and folders exist or
initial variable values are populated as
required.

c. Run the desktop PRE-PROCESS
CLEANUP.

d. Call the main bot to run the business
logic of the process.

In the FINALLY section, run the desktop
POST-PROCESS CLEANUP.

• Main bot: This bot calls the sub bots as
required to run the business logic of the
process. Include the following major process
steps in the TRY section:
a. Validation of any input. For example,

input variable values from the master
bot.

b. Execution of sub bots.
c. Validation of any output.
d. Ensure population of any output

variable values based on the execution
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of main bot, to return to the master
bot.

In the CATCH section, log the error, and
ensure population of any output variable
values, for example, oStrResult to pass
back to the master bot.

• Sub bots
• A sub bot is called by the master bot or

main bot to run the actual business logic
required for the automation. They are
also referred to as helper tasks or utility
tasks because their only purpose is to
assist the calling task.

• Use output variables to return a result
indicator to the calling bot either main,
or another sub bot. For example,
outStrResult. The value contains an
error message if the processing was not
successful due to an error or exception
that had occurred.

2. Main and Sub bots: This pattern includes the
master and the main bot in an single main bot.
The design pattern of the Sub bot is similar to
the design pattern explained above.

Opening and closing applications Any applications, files, or windows that a bot or
subtask opens must be closed by the same bot or
subtask.
• For example, when a bot opens Microsoft Excel

to perform a spreadsheet operation, verify that
the spreadsheet and Excel are closed when the
bot finishes processing.

• Close applications when the bot execution is
successful or unsuccessful.

• Use the Finally block of the Try/Catch/
Finally operation to ensure applications
are closed regardless of success of the task
processing.

• In the case that applications do not respond
during testing, consider using the command
prompt to forcefully close (kill) the applications.
For example, to forcefully close power point, the
command-line operation would be:

Taskkill /IM powerpnt.exe /F

Error handling After completing the task, verify that the bot
successfully handles any failure or exceptions.
• Each task or subtask must handle its own errors.
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• An unhandled exception in a subtask can cause
issues in a parent task.

• Use Try/Catch/Finally blocks at the root level
of every bot.

• Use Try/Catch blocks inside of a loop if you
want to try an operation multiple times before
reporting a failure.

Event or exception handling Other than action errors that are captured by
Try/Catch, you must perform code checks for
other processes such as events or exceptions. If a
certain process condition occurs, notify or log these
conditions for additional analysis.
• Develop a configurable event handler TaskBot

that minimizes the requirement for code changes
if the actions change. For example, maintain
an XML file that contains a definition of all
the possible events or exceptions and any
notification requirements when those events or
exceptions occur.

• In the code, when such events or exceptions
occur, write the information to an event log.
You can also add memory usages and capture a
screenshot.

• Run the event handler TaskBot to process
the event or exception. For example, issue a
notification using parameters such as email
recipient, CC recipient, or subject from the XML
file.

• If the notification requirements vary for
each environment, or change over time, the
configuration file can be updated without having
to change the code.

Running bots on other computers When designing a bot, enable it so it runs on
computers other than the computer on which a bot
was created.
• Use variables for local file paths, network

shares, or window titles so that your bot can
successfully run from other machines.

• Consider using global values for environment
markers or network shares that multiple bots
need access to.

• Use wildcard characters for window titles where
appropriate to enable bots to run regardless of
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specific environment or version of the target
application. For example, instead of using

Salesforce - Professional Edition
 - Internet Explorer

use the following:

Salesforce - * - Internet Explorer

Using prompts, message boxes, and infinite
loops

Prompts and message box actions stop the bots
from running when waiting for a user input. Unless
a user input is required, design the bots without
using prompt statements.
• When using loops, ensure all loops have a

definite end by clearly defining their number of
iterations or specifying where break loop actions
need to exist.

• If your bot is intended to run as an unattended
bot, remove or disable any prompts or message
box actions.

• If you are building bots for an attended
automation scenario, message boxes and
prompts are often reasonable or required for
bots to run as expected. Use message boxes to
display different variables, such as, responses,
outputs, or values.

Storing sensitive data in the Credential Vault The Control Room includes the Credential Vault that
can be used to store sensitive information, such as
user names, passwords, API keys, and tokens.
• When building a bot, create a locker in the

Control Room using the Credential Vault to store
credentials and retrieve them as required by
referencing the credential and the attribute. This
allows users to create bots that consume APIs or
perform logins without the need for bot builders
to directly hard-code the required credentials
within a bot.

• Do not hard-code sensitive credentials into a
bot, or a subtask, because hard-coded storage in
a bot introduces a security risk.

• When Credential Vault values are required to
be used in a bot, verify that all locker names
and credentials are clearly defined in the bot
documentation. If required, include details on
how to obtain credentials, for example, an API
key or a token.

Testing independent tasks When creating bots for reusability, design them in a
way that they can be tested independently of other
subtasks.
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• Practice the test-driven development (TDD)
approach: When adding a new bot, or a new
feature in an application, write a test case for it.

• In a test case, define the specific function that
validates that feature or functionality.

• For single-responsibility principle and reusability,
create many smaller tasks that can be tested
independently.

Using comments and steps Comments enable developers to provide
descriptions within their bots so that bot other
bot developers can better understand what each
section, block of code, or subtask is designed for.
Include clear comments to allow developers to
understand the purpose of the function of a given
code block.
• When bots are submitted to the Bot Store,

commenting demonstrates how to customize the
bot.

• Using comments makes code maintenance
easier because section descriptions help identify
where changes might be required to enable
developers to work towards quicker issue
resolution

• Comments on bots that are a work in progress
can be helpful when creating placeholders for
future work. Consider using a TODO command
as a reminder to add logic to the bot, but update
the comments when the work is completed.

• Automation 360 includes the Step action, which
provides the capability to organize the code into
logical groupings to improve readability and the
flow.

• Create an outline of the major objectives of your
bot by using empty, labeled step actions. When
that is completed, go back to each step and
complete the logic for the step.

Creating logging files Identifying problems without logs can be difficult
when bots are running unattended on any number
of Bot Runners. Software developers, support
teams, and bot owners rely on logs to understand
where their automations have issues and how to
diagnose problems. Bots must log errors to get
error details.
• Use error handling and screen captures to better

understand when a bot or subtask encounters
an error.

• Use the A2019 Bot Store template that contains
basic error handling, logging, and snapshot
capabilities with the customizable root logging
location for maintaining older log files.
Bot Store bot template
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• If required, create additional logging files and
include a full audit history of everything a bot
or subtask has done. The additional log files
can include audit, debug, and performance
information about the bot, as well as the
following:
• Main bot start and end time.
• Subtask start and end time.
• The completion time of specific milestones

defined within the bot.
• Number of transactions received in an input

file.
• Number of successfully processed or failed

transactions.

See also:  Best practices: Building reusable and secure Automation 360 bots and packages

Attività correlate
Utilizzo dell'action Loop alla pagina 1688
Use the Loop action to repeatedly run a sequence of actions for a specific number of times or until a
condition is met.
Riferimenti correlati
Le tue variabili (definite dall'utente) alla pagina 2026
Gli utenti e alcune actions creano variabili definite dall'utente per conservare temporaneamente dei valori.
Use this kind of variable to input values into an action (window title, login credential, or file path) or to
accept the output of an action (values read from a file or a Boolean return).
Application package alla pagina 1402
Use the Open Program/File action in the Application package to launch an application or a file. This
action supports .exe, .bat, script files, or shortcut paths.
Error handler package alla pagina 1523
Se un bot rileva un errore dovuto a una condizione anomala o a eccezioni durante l'esecuzione, la normale
esecuzione del bot è ostacolata e il bot non riesce a completare l'attività. Il package Error handler contiene
actions che consentono di gestire facilmente le eccezioni che un bot incontra trasferendo il controllo alle
altre actions all'interno di tale bot.
Step package alla pagina 1881
The Step package groups various actions together and runs them in a specific order. You can provide a
relevant name for a step to identify the operation performed by the actions included in that step.
Prompt package alla pagina 1745
Use the Prompt package to accept an input value, a yes/no response, or to open a file or folder.
Message box package alla pagina 1690
Use the Message box action from the Message box package to insert a message box that shows a
message when the task runs. For example, you can insert a Message Box action to follow a web form so
that the action displays the message: Web Form Filled and Complete.

Building reusable packages
Review the guidelines to understand how to build packages for reusability.

Know your incoming data When setting fields that your action package
requires from the user, provide specifics in setting
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the attribute type to limit the kinds of data that
your package receives.
• Limit the input to reduce the burden of checks

that have to be done when the package is
received.

• Javadoc includes 34 defined attribute types, so
review those when you build your package to
select the appropriate field types.

• Set your package so that it takes a stored
value. For example, on behalf of the bot, your
package is making API calls, verify that the
AttributeType of the action input field for the
API key or a token is set to credential. This way
users are encouraged to use a value stored in
the Credential Vault for sensitive input data that
the package requires.

Use labels appropriately In the CommandPkg annotation, use different labels,
node_labels, and descriptions appropriately.
• Use these labels as short descriptions of your

action and use only a few words to describe an
action.

• Replicate the same naming style as it is
presented in the default Action packages.

• Each action is a child element of a package,
and the action label is displayed along with the
package icon in the Actions pane. Use short
names to describe each action.

• Document an expected input format for certain
fields. Use the parameter description for
the @Pkg annotation. This allows package
developers to review the format, requirement, or
data that must be used for a specific input field.
Ad esempio:

@Pkg(label = "Start Date",
 description="Date Format as MM/
DD/YYYY"

Unit test your components During the package development, create unit tests
to validate that each component and the action of
the package is working as expected.
• Validate the behavior of the individual test unit,

a single class, or a single action, to ensure that it
is functioning as expected.

• Review and document any feature or
functionality defects at early stages of the
development process.

Handling errors Include the error handling in the bot logic to ensure
that all errors are handled gracefully. If an error
is not handled, it could prevent a bot runner from
executing other tasks.
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• Create meaningful error messages that can help
bot consumers with error resolutions.

• As a package developer, keep in mind these
recommendations:
• Use Try/Catch block to accommodate for an

error.
• Use a multi-catch block to find specific errors,

and use the BotCommandException
to return customized error messages. Ad
esempio:

//create array of 3 items
int[] myIntArray = new int[]{1,
 0, 7};
try {
    //print 4th item in array
   
 System.out.println(myIntArray[3]);
    //Perform operation on
 first and second items in
 array
    int result =
 myIntArray[0] / myIntArray[1];
} catch
 (ArrayIndexOutOfBoundsException
 e) {
    //Throw custom message for
 IndexOutofBounds
    throw new
 BotCommandException("The
 array does have the number of
 expected items.");
} catch (ArithmeticException e)
 {
    //Throw custom message on
 Atithmetic Exception
    throw new
 BotCommandException("Math
 Operation Error with " +
 Integer.toString(myIntArray[0])
 + " and " +
 Integer.toString(myIntArray[1]));
}

Follow single-responsibility principle A package is a collection of actions. Each action
within a package must have a single responsibility
and that responsibility must be encapsulated by
that action.
• Following the single-responsibility principle

helps your package consumers to implement it
easily, simplifies testing, and avoids unnecessary
modifications.

• The actions that you offer allow package
consumers to customize the way they use your
package within their bots, and can help their
bots be as efficient as possible.

© 2023 Automation Anywhere. All rights reserved.     2461



    Automation Anywhere - Crea

Provide examples When submitting packages to the Bot Store include
a demo bot that demonstrates the use of the
package.
• Use the Automation 360 actions and allow

package consumers to use these actions to
expend their bot capabilities.

• Always provide sample bots with descriptions
to help your package consumers with the
knowledge they require to understand its proper
use.

See also:  Best practices: Building reusable and secure Automation 360 bots and packages

Riferimenti correlati
Building reusable bots alla pagina 2453
Review the guidelines to gain a better understanding of how to develop bots or subtasks for reusability,
from designing and creating through reusing.

Troubleshooting and debugging
Troubleshooting and debugging information.

Troubleshoot bot run issue
Issue: I'm unable to deploy a bot because I get the following – Unexpected error setting up a new user
session.

Cause: Most often, this error is caused by invalid device
credentials.

Solution: Confirm the device is registered and connected.
1. Select Devices > My devices from the

Automation Anywhere web interface.
2. Confim that the Status column shows

Connected for the relevant device.

Confirm that the device username and password
are correct.
1. Select the profile icon on the Automation

Anywhere web interface and select Edit
profle.

2. Verify the device username.
Depending on how the device is configured
within the network, you might need to prepend
it with the domain name. For example,
domainname\firstname.lastname.

3. Verify the device password.
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Debugger tool
The Automation Anywhere Debugger tool helps you to identify and troubleshoot any issues during bot
running process.
The Debugger tool is available from:
• Assistant utility
• Bot editor

Open the bot from the Automation page and invoke the Debugger. You can add, update or delete actions
and variables within a bot when Debugger is invoked from the Bot editor.
The Bot editor canvas provides the following breakpoints controls that you can use for the Debugger tool:
• To insert a breakpoint, click the vertical ellipses and select Enable breakpoint.
• To disable a breakpoint, click the vertical ellipses and select Disable breakpoint. The breakpoint

becomes inactive.
• To clear all breakpoints, click the Clear all breakpoints icon.

The Debugger tool provides the following controls:
• Start debugger: Use to start the debugging process.
• Step Over: Use to move one action at a time.
• Stop: Use to stop the debugging process.
• Step Out: Use to jump to the next breakpoint directly. The Debugger tool skips to the next action and

pauses. When the debugging is in process, the Start debugger icon changes to Step Out.

Watched variables
You can use Watched variables to watch the values of the respective variable during bot execution. By
default, the Watched variables list is empty. With a single click, you can add used variables in a bot.
These variables are displayed in a pop-up window where you can select or deselect, one or more variables,
from the list.
You can add variables used in a bot to the Watched variables list using either of these methods:
• Select the Click here to add used variables link under No watched variables to add all of the

used variables in a bot with one click.
•

Click the x ( ) icon next to Watched variables to add or remove variables manually.
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The following pop-up is displayed when you click the x icon to add or remove variables manually:

When a bot updates the variables, the values of those variables are updated dynamically in the Watched
variables list. This provides a current status of a bot run at each action, and helps fix any bot-related
errors at an early stage from the Debugger tool.

The following pop-up window displays the list of Watched variables:
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Nota:
• You can run the Debugger tool using the Flow and List views. However, we recommend that you use

the List view to see which action is running.
• You cannot edit actions during the debugging process.
• If you rename a variable that is in the Watched variables list, then you must re-add it for it to appear

under Watched Variables list.
• Debugging of child bots from the parent bot is currently not supported.

Bot Agent log files
Various types of information about the Bot Agent are captured in different log files. You can analyze these
log files when the Bot Agent or a bot encounters an error and identify the root cause for that error.

Panoramica

The Bot Agent log files enable you to perform these actions:
• Determine whether a bot ran successfully
• Identify issues that resulted in a bot failure
• Determine if the device is properly connected with the Control Room

Log file locations

I file di registro Bot Agent sono disponibili in C:\ProgramData\AutomationAnywhere\BotRunner
\Logs sul tuo dispositivo. The following files are available at this location:

Bot_Launcher Captures information about the execution of a bot
such as the operations performed, events triggered,
and errors encountered by the bot.
The filename now includes the name of the user
running the bot on the Bot Runner. For a multi-user
session machine, there will be a bot launcher log
per user.

Node_Manager Captures information about when a bot is run
from the Control Room and communication details
between a Bot Runner and the Control Room.

Log file configuration

To configure the different types of log files that can be collected from the devices connected to the Control
Room, see Configure log collection alla pagina 2729.
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Digitalizzazione
Automation Anywhere offers several web-based intelligent document processing solutions that extract
semi-structured data from documents and convert it into structured data, which can be used by Robotic
Process Automation (RPA) bots for automation of business processes.

Panoramica

Typically, RPA bots can automate only those tasks that involve processing structured data. As a result,
about 80% of a business's data remains inaccessible to RPA bots as "dark data." This dark data is made
accessible to RPA bots by cognitive automation, which combines the technologies of intelligent document
processing and RPA. With cognitive automation, semi-structured data is extracted from documents such
as invoices, and converted into structured data, so RPA bots can subsequently use this structured data for
automating business processes.

Learn more about the Automation Anywhere intelligent document processing solutions:

Document Automation Document Automation è la nuova soluzione
nativa del Cloud per l'elaborazione intelligente
dei documenti che gli utenti aziendali
possono impostare per leggere ed elaborare
automaticamente e rapidamente i documenti
utilizzando modelli preaddestrati e feedback di
convalida.
Document Automation on page 2553

Automation 360 IQ Bot In Automation 360 IQ Bot, users configure
templates and train bots to extract data from a
variety of documents. Automation 360 IQ Bot is
available for on-premises and cloud installations,
and offers users a wide range of tools to customize
and optimize document processing, including the
following:
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• Packages to create models for classifying
documents by category and to enhance the
quality of documents or images for better
extraction

• Standard form models for extracting data from
documents that have minimal or no variation in
their layout

• Support for Optical Character Recognition (OCR)
engines to improve the accuracy of the extracted
data

Automation 360 IQ Bot on page 2472
IQ Bot 11.3.x This early version of IQ Bot supports Enterprise

11 customers. It is available for on-premise
installations only.
IQ Bot 11.3.x

Community Edition La versione Community Edition offre agli
utenti funzionalità limitate delle soluzioni per
l'elaborazione dei documenti Document Automation
e Automation 360 IQ Bot. This version is available
to users for free.
Community Edition on page 2467

Community Edition
La versione Community Edition offre agli utenti funzionalità limitate delle soluzioni per l'elaborazione dei
documenti Document Automation e Automation 360 IQ Bot. This version is available to users for free.
Gli utenti non sono tenuti ad acquistare una licenza e non esistono limiti temporali. Tuttavia, vi sono alcuni
vincoli di funzionalità, come segue:
• È possibile creare fino a un massimo di cinque istanze di apprendimento per utente.
• Non è possibile eliminare un'istanza di apprendimento.
• Nell'elenco delle istanze di apprendimento, puoi visualizzare e accedere solo alle istanze di

apprendimento e ai dati che hai creato.
• You cannot integrate a Community Edition version of Document Automation with an Automation 360 IQ

Bot environment.
• Google Document AI and Standard forms are not supported.

Introduzione a Community Edition

Per iniziare a usare Community Edition:
1. Registrati e accedi a Community Edition:

Completa i passaggi uno e due di Introduzione a Community Edition on page 1021.
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2. Installa Bot Agent e imposta le credenziali del dispositivo utente.
a. Vai a Gestisci > Dispositivi e fai clic su Connetti dispositivo locale. Segui i passaggi della

procedura guidata per collegare la Control Room al tuo dispositivo.
b. Fai clic su Aggiorna per verificare che il dispositivo sia collegato.
c. Fai clic sul tuo nome utente. Vai a Le mie impostazioni > Dispositivi > Credenziali. Fai clic

su Modifica per fornire il nome utente e la password del dispositivo.

3. Vai a Gestisci > Istanze di apprendimento e seleziona una versione di IQ Bot per iniziare a creare
istanze di apprendimento:
• Opzione 1: Fai clic sull'opzione Crea istanza di apprendimento.

Crea istanze di apprendimento per estrarre i dati dalle fatture in Document Automation: Creare
un'istanza di apprendimento in Community Edition on page 2468

• Opzione 2: Fai clic sull'opzione Addestra altri documenti.
Crea istanze di apprendimento per estrarre dati da altri tipi di documenti utilizzando Automation
360 IQ Bot: Guida rapida a IQ Bot Community Edition

Creare un'istanza di apprendimento in Community Edition
Crea un'istanza di apprendimento per iniziare l'elaborazione dei documenti. In Community Edition, ora puoi
estrarre i dati dalle fatture in inglese utilizzando il fornitore OCR ABBYY.
1. From the Control Room home page, navigate to Manage > Learning Instances > Create

Learning Instance.
2. Enter a name and description for the learning instance.

Document Automation does not allow duplicate learning instance names, so the name you provide
must be unique.

3. Fai clic su Avanti.
We recommend that you open a sample document side by side with the Control Room window as you
configure the form and table fields.

Note:
• A form field is a type of field that occurs only once in a document.
• A table field is a type of field that reoccurs throughout a document, typically in the form of a table.

4. Configure the form and table fields for extraction.
Document Automation offers a standard set of form and table fields, many of which are not initially
visible. You can search for a field by field name, field label, or data type.
To see the full list of fields, click Show unused fields. See the following video for a demonstration:
Click a field to open the fields editor. You can edit most attributes of a field. You cannot edit the name
and default aliases. Document Automation assigns default aliases, which are hardcoded keywords, to
standard fields to help with extraction. You cannot modify or delete default aliases, but you can add
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aliases in the Custom aliases field. See the following video for a demonstration of creating a custom
alias:

Note:  Custom fields are not available for learning instances that use the Google Document AI
provider.

Mouse over the menu icon to the right of a field to access the up/down arrows. Use the arrows to
rearrange the order of the fields for a more efficient manual validation. L'ordine dei campi non influisce
sull'estrazione.
To learn more about the other field attributes, review the table in the next step.

5. Per aggiungere un campo, fai clic su Aggiungi campo e completa i seguenti campi:
Opzione Descrizione

Nome campo Immetti un nome di un campo che inizi con un carattere alfabetico (A-Z o a-z).
In standard fields, the field name is hardcoded and cannot be changed.

Etichetta del
campo

Immetti un nome intuitivo per aiutare i validator.
Ad esempio, è possibile rinominare il Codice fiscale
dell'organizzazione con un nome localizzato, ad esempio Partita IVA.
The field label does not affect extraction.

Attendibilità Imposta una soglia per ridurre i potenziali falsi positivi.
At the time of processing, the Document Automation engine assigns a score to
each field in a document to indicate the certainty that the data was correctly
extracted. Se il documento contiene campi con un punteggio inferiore alla soglia
di confidenza, il documento viene inviato alla coda di convalida.
If you enter a high confidence threshold, more documents will be sent to the
validation queue. If you enter a low confidence threshold, fewer documents will
be sent to the validation queue.
Supports values from zero to 100.

Tipo di dati Choose from Address*, Text, Number, and Date.
If the data in the field does not match the data type, the document is sent to
the validation queue.
Document Automation supports date and number format variations.
* If you are configuring a learning instance with a user-defined document type,
the form fields include the address data type, which extracts the entire structure
of an address.

Obbligatorie Seleziona una delle seguenti:
• Required: Field cannot be empty.
• Facoltativo: Field can be empty or not exist in the document.

Alias predefiniti Non è necessaria alcuna azione per questo campo. Document Automation
assigns default aliases, which are hardcoded keywords, to standard fields to
help with extraction.
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Opzione Descrizione

Alias
personalizzati

Additional keywords to help Document Automation locate the field. Ad
esempio, aggiungi nomi specifici per Paese o regione per campi come
Partita IVA come alias di un campo personalizzato Codice fiscale
dell'organizzazione.

Note:  Custom aliases must be unique. They cannot duplicate the default alias
of another field. Exception: Form fields can have duplicate custom aliases as
the table fields and vice versa.

Validation rules Depending on data type, create rules using patterns, formulas, lists, and
statements such as starts or ends with.
Convalida della formula on page 2580 | Pattern validation on page 2583

6. Fai clic su Crea.

Carica documenti nell'istanza di apprendimento, correggi gli errori di convalida e verifica i dati estratti:
Elabora documenti in Community Edition on page 2470

Elabora documenti in Community Edition
Carica fatture di esempio per addestrare l'istanza di apprendimento, verifica i dati estratti e correggi gli
errori di convalida.
• Se non l'hai già fatto, Creare un'istanza di apprendimento in Community Edition on page 2468
• Assicurati che ogni file non superi i 2 MB.
• Assicurati che le fatture di esempio siano nei seguenti tipi di documenti supportati:

• PDF
• JPG
• JPEG
• PNG
• TIF
• TIFF
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Carica le fatture di esempio in un'istanza di apprendimento per testarne le funzionalità di estrazione dei
dati. Se un documento richiede una convalida manuale, il sistema lo invia a Validator, dove è necessario
inserire manualmente i dati corretti.
1. Carica i documenti nell'istanza di apprendimento:

Note:  Community Edition può elaborare un massimo di cinque documenti alla volta. Per caricare un
altro documento, devi attendere il completamento dell'elaborazione (e della convalida, se necessario)
di un documento.

a) Fai clic su Elabora documenti.
b) Nella finestra Elabora documenti, fai clic su Sfoglia per selezionare i file da caricare.
c) Nel campo Scarica i dati in, inserisci il percorso file in cui i dati estratti vengono restituiti come

file CSV.
d) Fai clic su Elabora documenti.

The Bot Runner window appears. The window disappears when the documents are done
processing. Refresh the Learning instances table to see the updated metrics.

Se c'è un valore accanto al collegamento Convalida documenti, devi convalidare manualmente i campi
con errori. Altrimenti, vai al passaggio 2b per rivedere i dati estratti.
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2. Fix the validation errors
a) Fai clic su Convalida documenti.

The AARI Task Manager opens in a new tab, with the first failed document in queue. For an
introduction to the Validator user interface, see Using the AARI Task Manager Validator for Document
Automation on page 2593.

b) Review each field to verify the data type and extracted value.
Document Automation supports the following data types: text, number, time, and check box
Alternatively, from the drop-down list on the right panel, you can select Show fields that need
validation.

Note:  When documents are awaiting validation, if you edit the learning instance, click
Reprocess to reattempt extraction.
Reprocessing documents does not affect the uploaded documents metric.

c) Update the fields with errors.
Click the field or draw a box around the values that you want to extract.
For Automation Anywhere pre-trained models, you can configure the learning instance to extract
specific values in a field and ignore others. Per ulteriori informazioni, consulta Using validation
feedback to extract specific values in a table on page 2573.

• To skip a document without correcting errors, click Skip to proceed to the next document in
the validation queue.

• Per rimuovere un documento che non può essere elaborato, fai clic su Contrassegna come
Non valido.

d) After you make the necessary corrections, click Submit so that the document can finish
processing.
The next document in queue appears. When all the documents are corrected, the system displays
a message stating that no more tasks are available.

e) Chiudi la scheda per tornare alla pagina Istanze di apprendimento.

3. Verificare i risultati dell'output:
a) Open the file in the Success folder that contains the extracted data and review the results to

ensure that it matches your use case.
b) Optional: Review the Learning Instance dashboard.

The dashboard displays the total number of uploaded documents and the number of documents
pending validation.

Congratulazioni! Ora hai elaborato correttamente i tuoi primi documenti nella versione Community Edition
di Document Automation.

Automation 360 IQ Bot
Automate document-centric business processes, end to end, by using IQ Bot, a web-based, Cloud-native
intelligent document processing solution that can read and process complex documents and email. This
solution combines RPA with AI techniques to extract and classify semi-structured and unstructured data.
Automation 360 IQ Bot is a hybrid solution for On-Premises and Cloud deployments.
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Note:  From Build 4695 (A2019.13), Automation 360 IQ Bot has feature parity with IQ Bot Version
11.3.4.2 and some features from Version 11.3.5. Per informazioni sulla parità di caratteristiche tra
Automation 360 IQ Bot e le corrispondenti versioni IQ Bot 11.x, vedi Matrice di confronto delle funzionalità
per Automation 360 IQ Bot on page 735.

Panoramica

The technologies of IQ Bot and RPA together constitute cognitive automation. With cognitive automation,
IQ Bot extracts semi-structured and unstructured data and converts it into structured data, and RPA bots
subsequently use this structured data for automating business processes.
IQ Bot works by using learning instances. A learning instance is a structure that holds information such
as document type, language, and fields to be extracted from tables and forms. A learning instance also
includes bots that are trained to extract data from documents.
IQ Bot is also supported by RPA bots that are built for functions such as training the Classifier, sharpening
document resolution, and downloading the extracted data.
After the bots in a learning instance are trained and the necessary RPA bots are built, a learning instance
is set to production mode. After that, IQ Bot can start processing documents automatically, through the
following steps:
1. Retrieves documents from a source, such as attachments in incoming email
2. Improves document quality
3. Classifies documents into groups
4. Extracts data
5. Either downloads the extracted data or first sends the document for manual validation and then

downloads the data

Types of IQ Bot users

In many organizations, different types of users perform specific tasks within their product area to create,
configure, and publish a learning instance and the supporting assets. To learn more about the user types,
required licenses, roles, and permissions, and the assigned product areas, see IQ Bot user personas on page
2477.
The following diagram demonstrates the sequence of how a learning instance and supporting assets are
built, as well as which user performs which task.
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Per iniziare con le istanze di apprendimento

Perform the following these steps to create a learning instance, train bots, and set the bots to production:
• Utilizzo dell'On-Premises Automation 360 IQ Bot on page 2475
• Utilizzo dell'Cloud Automation 360 IQ Bot on page 2476

Build RPA bots for IQ Bot

The following links guide you in configuring RPA bots to support IQ Bot functions.
• Use the IQ Bot Classifier package to improve classification and prevent invalid documents from being

uploaded to a learning instance.
Train the classifier | Classify documents
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• Use the IQ Bot Pre-processor package to prepare documents and extract data before processing.
Using EnhanceImage action on page 1651 | Using ConvertImageToPDF action on page 1649

• After sending a learning instance to production, configure a bot with the Process documents action
from the IQ Bot Extraction package: IQ Bot Extraction package on page 1654

• Download extracted data

Risorse

For more information, review the courses in the IQ Bot Developer learning trail: IQ Bot Developer Training
(A-People login required).
You can also search for the following courses in Automation Anywhere University: RPA Training and
Certification (A-People login required):
• Elaborazione intelligente dei documenti con IQ Bot
• Libera i tuoi bot intelligenti: Sviluppo di bot cognitivi guidati dall'intelligenza artificiale e dall'apprendimento

automatico (IQ Bot)

Related concepts
Installazione e aggiornamento Automation 360 IQ Bot on page 1066
This collection of topics guide you through the process of installing or setting up Automation 360 IQ Bot
On-Premises and Cloud.
Languages supported in Automation 360 IQ Bot on page 2481
Up to 31 languages are supported in IQ Bot. You can also access up to 190 languages in IQ Bot by using
an OCR engine.

IQ Bot architecture diagram
This diagram shows the different components of IQ Bot architecture.
Use the IQ Bot, components, Designer and Validator for designing and validating bots, respectively. In a
typical scenario, IQ Bot portal and IQ Bot platform communicate through a network firewall and a load
balancer.

Various protocols are used to communicate between the different components. A database server, a file
storage server, and servers for IQ Bot are used. An organization has the flexibility of using a separate
server for the database or using the Control Room clusterdatabase. A firewall is between the external
components, web browser and Bot Runner, and the data center load balancer. Chrome is the supported
browser.

Utilizzo dell'On-Premises Automation 360 IQ Bot
Create a learning instance, train the bots to extract data from documents, and push the learning instance
to the production environment.
Completamento della procedura di Installazione IQ Bot.
You must be assigned either the IQ Bot Admin or IQ Bot services roles.
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As you configure a learning instance, a Bot builder creates RPA bots to support the learning instance
functions. For more information, see IQ Bot process overview.
1. In Automation 360 IQ Bot, click the LEARNING INSTANCES tab to create a new learning instance,

upload sample documents to train, and select the OCR engine for document processing.
Creare un'istanza di apprendimento on page 2487
Selezione di un motore OCR on page 2490

2. Addestrare i documenti di esempio caricati in IQ Bot Designer.
Formare un'istanza di apprendimento on page 2498

3. As you finish training each bot, set it to Production mode. When all the bots are in Production mode,
set the learning instance to Production mode so it can start processing real documents.
Attività eseguite dalla pagina Bot on page 2502
Impostazione di un'istanza di apprendimento su Produzione on page 2527

Utilizzo dell'Cloud Automation 360 IQ Bot
Create a learning instance, train the bots to extract data from documents, and push the learning instance
to the production environment.
Completamento della procedura di Installazione IQ Bot.
You must be assigned either the IQ Bot Admin or IQ Bot services roles.
As you configure a learning instance, a Bot builder creates RPA bots to support the learning instance
functions. For more information, see IQ Bot process overview.
1. In Automation 360 IQ Bot, fai clic sulla scheda Istanza di apprendimento per creare una nuova

istanza di apprendimento e caricare i documenti di esempio da addestrare.
Creare un'istanza di apprendimento on page 2487

Note:  Poiché l'API Tegaki OCR richiede una configurazione On-Premises separata non supportata in
Automation 360 IQ Bot Cloud, sono disponibili tutti gli altri motori OCR ad eccezione dell'API Tegaki
OCR.
• Sarà sempre disponibile la versione più recente dei motori OCR supportati da Automation 360 IQ

Bot Cloud, ma non sarà possibile selezionare una versione specifica di OCR.
• Non è possibile configurare le impostazioni di OCR dalla Control Room. A partire dalla versione .19

di Automation 360 IQ Bot, viene fornita un'API interna che può essere utilizzata per configurare le
impostazioni di OCR nel database.

2. Addestrare i documenti di esempio caricati in IQ Bot Designer.
Formare un'istanza di apprendimento on page 2498

3. As you finish training each bot, set it to Production mode. When all the bots are in Production mode,
set the learning instance to Production mode so it can start processing real documents.
Attività eseguite dalla pagina Bot on page 2502
Impostazione di un'istanza di apprendimento su Produzione on page 2527

IQ Bot user personas and roles
Learn about the users that contribute to IQ Bot and the associated roles and licenses. IQ Bot users and
roles are defined in the Control Room.
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IQ Bot user personas

A persona refers to the type of tasks that a user performs and the product areas with which a user
interacts. To learn more about how each user contributes to IQ Bot, see IQ Bot process overview.

Tipo di utente Descrizione Roles,
permissions, and
licenses

Access to product
areas

Related links

Bot builder Builds RPA bots
to support IQ Bot
functions such
as training the
Classifier and
pre-processing
documents

Bot developer
role + Bot creator
license

Automation 360 Build RPA bots for
IQ Bot on page
2474

Data engineer Creates learning
instances, trains
bots, and sends
bots to production

IQ Bot Admin or
IQ Bot services
roles

Following tabs in
Automation 360
IQ Bot
• Dashboard
• Learning

Instances
• Bot
• Domains
• Administration

(IQ Bot
Admin only)

Utilizzo dell'On-
Premises
Automation 360 IQ
Bot on page 2475
Utilizzo dell'Cloud
Automation 360 IQ
Bot on page 2476

Amministratore Uploads custom
domains and
migrates learning
instances
between IQ Bot
environments

IQ Bot Admin role
or a custom role
with the migration
utility permission

Following tabs in
Automation 360
IQ Bot
• Dashboard
• Learning

Instances
• Bot
• Domains
• Amministrazione

Custom domains
in IQ Bot on page
2536
Migrazione
delle istanze di
apprendimento on
page 1347

Pseudo-user Runs the RPA bots
to upload, pre-
process, classify,
and extract data
from documents
in IQ Bot

Unattended
Bot Runner
license + view
learning instance
permission

Automation 360 e
IQ Bot

Validator Manually
corrects fields in
documents that
IQ Bot could not
process

Validator role Only the learning
instances to which
permission is
granted

Use the IQ Bot
Validator on page
2530
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IQ Bot ruoli

A role determines the areas in IQ Bot to which you have access. Roles are assigned in the Control Room
and are of two types, predefined system roles and custom roles. If your user type is Admin, you can create
custom roles.
• System roles: These roles are built in and have a predefined set of permissions that cannot be

customized.
• Custom roles: questi ruoli possono essere personalizzati e modificati per concedere autorizzazioni

granulari a un utente IQ Bot. An admin can configure the scope of a role with organization-wide
permissions to manage all organizational resources or more narrowly to be limited to department-level
resources. Per ulteriori informazioni, consulta Definizione di un ruolo personalizzato per IQ Bot on page
2478.

The following table describes the permissions and access areas applicable to each system role:

Ruolo di sistema Autorizzazioni per IQ Bot Accesso alle schede

AAE_IQ Bot Admin Access to all IQ Bot
features and can migrate
learning instances between
environments

• Dashboard
• Learning Instances
• Bot
• Domains
• Administration Migration

utility

AAE_IQ Bot Services All permissions related to
learning instances

• Dashboard
• Learning instances
• Bot

AAE_IQ Bot Validator Can launch the Validator for
granted learning instances

Istanze di apprendimento

Related concepts
Definizione di un ruolo personalizzato per IQ Bot on page 2478
Per vari ruoli all'interno di IQ Bot puoi utilizzare il controllo degli accessi basato sul ruolo (RBAC) per
abilitare o limitare l'accesso degli utenti alle istanze di apprendimento, alle funzioni e funzionalità correlate
definendo autorizzazioni granulari. Puoi anche usare RBAC per definire ruoli personalizzati in IQ Bot.
Related tasks
Creazione di un utente con un ruolo IQ Bot specifico on page 2480
Creare utenti in Control Room per accedere a IQ Bot.
Related reference
Licenze Automation 360 on page 1010
La pagina Tutte le licenze mostra informazioni dettagliate sulle licenze correnti di prodotti e dispositivi.

Definizione di un ruolo personalizzato per IQ Bot
Per vari ruoli all'interno di IQ Bot puoi utilizzare il controllo degli accessi basato sul ruolo (RBAC) per
abilitare o limitare l'accesso degli utenti alle istanze di apprendimento, alle funzioni e funzionalità correlate
definendo autorizzazioni granulari. Puoi anche usare RBAC per definire ruoli personalizzati in IQ Bot.
IQ Bot supporta due tipi di definizioni di ruoli:
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• Ruoli di sistema in Control Room: These roles are built-in and have a pre-defined set of permissions
that cannot be customized. Per ulteriori informazioni, consulta IQ Bot ruoli on page 2478.

• Ruoli personalizzati in Control Room: questi ruoli possono essere personalizzati e modificati per
concedere autorizzazioni granulari a un utente IQ Bot. If you are an admin, by creating a custom role,
you can grant users access to specific learning instances.

If you are a user with the View and Manage Roles permission, you can use the Control Room to create
and assign custom roles.

Autorizzazione Descrizione

Le mie istanze di apprendimento Permette a un utente di accedere alle proprie
istanze di apprendimento.

Visualizza istanze di apprendimento dello stesso
ruolo

Permette a un utente di visualizzare solo le
istanze di apprendimento create dallo stesso
ruolo.

Note:  Se a più utenti viene assegnato lo stesso
ruolo, allora tutti questi utenti avranno accesso
alle stesse istanze di apprendimento.

Visualizza tutte le istanze di apprendimento Consente agli utenti di visualizzare tutte le
istanze di apprendimento create da qualsiasi
utente in tutti i ruoli.

Modifica istanza di apprendimento Permette agli utenti di modificare le istanze di
apprendimento.

Elimina istanza di apprendimento Permette agli utenti di eliminare le istanze di
apprendimento.

Invia istanza di apprendimento in produzione Permette agli utenti di spostare le istanze di
apprendimento dallo staging alla produzione.

Importa dominio Permette agli utenti di importare domini in IQ
Bot.

Cose da ricordare:
• Assicurati che gli utenti con Visualizza istanze di apprendimento dello stesso ruolo non abbiano

ruoli non IQ Bot. Esempio: When you create a learning instance, all the roles that you have under your
name gets assgined to the learning instance. So, if you have AA_Basic role in combination with View
learning instance from the same role, then all the users with AA_Basic role have access to IQ Bot.
Therefore, users who create learning instances must not be assigned non-IQ Bot roles.

• Ai creatori di istanze di apprendimento di un dipartimento specifico devono essere assegnati almeno
due ruoli:
• Un ruolo che permette loro di creare istanze di apprendimento
• Un ruolo specifico del dipartimento con autorizzazione Visualizza istanze di apprendimento

dello stesso ruolo

• Quando viene eseguita la migrazione delle nuove istanze di apprendimento, i ruoli esistenti non saranno
sottoposti a migrazione. Dopo che i ruoli sono stati assegnati nel sistema di destinazione, non possono
essere modificati. IQ Bot A360 non supporta la modifica delle assegnazioni dei ruoli delle istanze di
apprendimento.
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Related tasks
Create a role on page 2693
As an administrator, you can configure roles with permissions to access features and perform operations
such as create, edit, or delete a bot in the Control Room, and assign the role to a user.
Creazione di un utente con un ruolo IQ Bot specifico on page 2480
Creare utenti in Control Room per accedere a IQ Bot.

Creazione di un utente con un ruolo IQ Bot specifico
Creare utenti in Control Room per accedere a IQ Bot.
Puoi creare l'amministratore, servizi e utenti di Validator IQ Bot con le credenziali Windows utilizzando i
ruoli seguenti in Control Room:
• AAE_IQ Bot Admin
• AAE_IQ Bot Services
• AAE_IQ Bot Validator

Tip:  Gli utenti di Active Directory vengono autenticati con le credenziali di Active Directory mentre gli
utenti non Active Directory vengono autenticati con le credenziali archiviate nel database Control Room.

Gli utenti in Control Room vengono creati a seconda del tipo di utente configurato durante l'installazione.

Note:  IQ Bot supports 50 concurrent users. However, Document Extraction if all users are active at the
same time, then you cannot run Document Extraction in parallel. Additionally, if the number of concurrent
users exceeds 50, system performance might degrade.

1. Log in to Control Room as a user with the AAE_Admin role.
2. Accedi a Amministratore > Utenti.
3. Fai clic sull'icona Crea utente.

Viene visualizzata la pagina Crea utente.
4. Immetti le informazioni richieste nella pagina Crea utente.

Note:
• I campi Nome Cognome e Descrizione sono facoltativi. Per il nome e il cognome puoi utilizzare

numeri, spazi ( ), punto (.), trattino (-) e carattere di sottolineatura (_).
• Per gli utenti non Active Directory, fornire informazioni in ciascun campo.

5. Per creare un utente con il ruolo di amministratore, seleziona AAE_IQBotAdmin. Per creare un
utente con il ruolo servizi, seleziona AAE_IQBotServices, per creare un ruolo Validator, seleziona il
ruolo AAE_IQBotValidator.

6. Seleziona una licenza da assegnare all'utente dalla sezione Assegna una licenza per dispositivo
all'utente.
Se non sono disponibili slot di licenza per un ruolo, viene visualizzato un messaggio di avviso.

7. Fai clic su Salva per creare l'utente.

Per cambiare il tipo di utente da Sviluppo a Run-time o viceversa a seconda dei requisiti di automazione
della tua organizzazione, aggiorna il tipo di licenza nella sezione Gestione licenze in Control Room.
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Una volta creato un Validator o un utente servizi, l'utente riceverà un'e-mail. All'utente verrà richiesto di
effettuare le seguenti operazioni:
• Verificare l'ID e-mail e impostare la password di accesso a Control Room, se la Control Room è

configurata per gli utenti non-Active Directory.
• Verificare l'ID e-mail se la Control Room è configurata per gli utentiActive Directory.

Related concepts
Definizione di un ruolo personalizzato per IQ Bot on page 2478
Per vari ruoli all'interno di IQ Bot puoi utilizzare il controllo degli accessi basato sul ruolo (RBAC) per
abilitare o limitare l'accesso degli utenti alle istanze di apprendimento, alle funzioni e funzionalità correlate
definendo autorizzazioni granulari. Puoi anche usare RBAC per definire ruoli personalizzati in IQ Bot.

Languages supported in Automation 360 IQ Bot
Up to 31 languages are supported in IQ Bot. You can also access up to 190 languages in IQ Bot by using
an OCR engine.
When you review the list of languages in IQ Bot, you will observe the following:
• Alcune lingue sono elencate più volte come varianti, ad esempio norvegese, norvegese (Bokmal),

norvegese (Nynorsk).
• Among languages that are written from right to left, only Arabic is currently supported on IQ Bot.
• Per le lingue non presenti nell'interfaccia utente di IQ Bot per impostazione predefinita:

• These rely on ABBYY FineReader Engine 12.2 for text segmentation and OCR, then IQ Bot for
classification, extraction, and auto-correction.

• Contact your Cognitive Services or Sales Engineering representative to create IQ Bot custom
domains to access these languages.

• Nel database SQL e nel file .json, IQ Bot richiede i codici lingua affinché 160 delle lingue
aggiuntive possano essere visualizzate nell'interfaccia utente e i codici culturali per consentire la
convalida dei valori numerici e della data.

Nota:
• Per ABBYY FineReader Engine e Microsoft Azure Computer Vision OCR engine, IQ Bot utilizza la

segmentazione del testo + OCR.
• Per Microsoft Azure Computer Vision OCR engine, l'utente può selezionare qualsiasi lingua dal menu a

discesa di IQ Bot, ma l'API mira a rilevare automaticamente la lingua durante l'elaborazione e ignorare
la selezione dell'utente.

The following table provides a list of supported languages in IQ Bot for various document types:

Lingua Document types such as invoice, contracts, health
insurance, purchase order, and so on

Document type - Other

English X X

Tedesco X X

Francese X X

Spagnolo X X

Italiano X X

Afrikaans X
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Lingua Document types such as invoice, contracts, health
insurance, purchase order, and so on

Document type - Other

Arabo X

Bulgaro X

Catalano X

Cinese (semplificato) X

Cinese (tradizionale) X

Repubblica Ceca X

Danese X

Olandese X

Flemish X

Greco X

Ungherese X

Indonesiano X

Giapponese X

Coreano X

Latino X

Malese X

Norvegese X

Polacco X

Portoghese X

Rumeno X

Russo X

Serbo (latino) X

Slovacco X

Svedese X

Turco X

The following table lists the languages that are supported in IQ Bot through a custom domain:

Abcaso Gallego Mari Sioux (Dakota)

Adighè Ganda Maya Sloveno

Agul Tedesco Miao Somalo

Albanese Tedesco (nuova
ortografia)

Minangkabau Sorbo

Armeno (orientale) Tedesco (Lussemburgo) Russo e inglese Sotho

Armeno (grabar) Guarani Moicano Sunda
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Armeno
(occidentale)

Hani Mongolo Swahili

Avar Hausa Mordvino Swazi

Aymara Hawaiano Nahuatl Tabassaran

Baschiro Islandese Neneti Tagalog

Basco Ido Nivkh Tahitiano

Bielorusso Interlingua Nogay Tagico

Bemba Irlandese Norvegese Nynorsk e
norvegese Bokmal

Tataro

Piedi neri Cabardo Norvegese (Bokmal) Thailandese

Bretone Calmucco Norvegese (Nynorsk) Jingpo

Bugotu Caraciai-balcaro Nyanja Tongano

Burmese Caracalpaco Occidental Tswana

Buriato Casciubo Ojibway Tun

Chamorro Kawa Inglese antico Turkmeno

Ceceno Kazaco Francese antico Turkmeno (latino)

Chukcha Chakasso Tedesco antico Tuvano

Chuvash Mansi Italiano antico Udmurto

Corso Kikuyu Slavo antico Uiguro (cirillico)

Tartaro crimeo Kirghiso Spagnolo antico Uiguro (latino)

Croato Kongo Ossezio Ucraino

Crow Coreano (Hangul) Papiamento Uzbeco (cirillico)

Dargwa Coriaco Tok Pisin Uzbeco (latino)

Dungan Kpelle Portoghese (Brasile) Vietnamita

Olandese (Paesi
Bassi)

Cumucco Portoghese (Portogallo) Cebuano

Eschimo (cirillico) Lak Provenzale Gallese

Eschimo (latino) Sami (lappone) Quechua Wolof

Esperanto Lettone Retoromancio Xhosa

Estone Latvian (language
written in Gothic script)

Rumeno (Moldavia) Jakuto

Even Lesghi Romaní Yiddish

Evenki Lituano Ruanda Zapoteco

Faroese Luba Rundi Zulu

Figiano Macedone Russo (vecchia
ortografia)
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Finlandese Malgascio Russo (con accenti che
indicano la pronuncia)

Frisone Malinke Samoano

Friulano Maltese Selkup

Gaelico scozzese Mansi Serbo (cirillico)

Gagauzo Maori Shona

The following table provides you with links to supported languages for all IQ Bot supported OCR engines:

Motori IQ Bot OCR supportati Elenco delle lingue supportate

ABBYY FineReader Engine ABBYY FineReader Engine OCR supported
languages

Microsoft Azure Computer Vision OCR engine https://docs.microsoft.com/en-us/azure/cognitive-
services/computer-vision/language-support

Google Vision API https://cloud.google.com/vision/docs/languages

Tesseract4 OCR 4.0.0 https://tesseract-ocr.github.io/tessdoc/Data-Files-in-
different-versions.html

Tegaki API • Giapponese
• Coreano
• Giapponese - Inglese
• Coreano - Inglese

Nota:  The supported languages in IQ Bot must be considered in concurrence with the OCR supported
languages.

Suggerimento:  Se non riesci a visualizzare tutte le lingue nell'interfaccia utente di IQ Bot o se IQ Bot
non è in grado di estrarre dati da più lingue in un documento, risolvi il problema:
Unable to extract data from Multiple languages in a document (A-People login required)

Nota:  If you are adding custom language to a custom domain, then you must retain the language ID
across all installations from where IQ Bot learning instances will be exported and imported.

Informazioni sul Classificatore
Impara come vengono classificati i documenti e i fattori che influenzano la classificazione.
Quando i documenti vengono caricati in un'istanza di apprendimento, il Classificatore li ordina in gruppi
di documenti basati sul layout, cioè l'ordine in cui i campi appaiono sulla pagina. Se un documento viene
caricato in un'istanza di apprendimento in produzione e il documento non corrisponde al layout di nessuno
dei gruppi di documenti, il Classificatore crea un nuovo gruppo per quel documento.
Il seguente grafico illustra come le fatture caricate che contengono campi specifici sono ordinate in uno dei
tre gruppi, a seconda dell'ordine in cui i campi appaiono nella fattura.
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In alternativa, è possibile definire manualmente un gruppo di documenti per elaborare tutti i documenti
con un layout identico. In questo caso, IQ Bot bypassa il Classificatore e invia il documento al gruppo che
hai creato e che ha lo stesso layout del documento caricato. Questa opzione è utile quando l'OCR non
riesce a rilevare uno o più campi in un documento, facendo sì che il Classificatore crei inutilmente un nuovo
gruppo di documenti o invii il documento al gruppo sbagliato. Consulta Create a new document group on
page 2486.

Note:  I gruppi di documenti creati dall'utente non possono essere eliminati.

The Classifier is supported by RPA bots and the IQ Bot Classifier package. It contains actions that
automate identifying and sorting the different document types. Consulta IQ Bot Classifier package on page
1641.

Risorse

Watch the following videos to learn more about how the Classifier works and how to use it:
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Istanze di apprendimento create con domini predefiniti o personalizzati

IQ Bot cerca un numero minimo di campi selezionati per classificare correttamente il documento. In tutti gli
altri casi, il documento viene contrassegnato come non classificato.
Ad esempio:
• Se crei una nuova istanza di apprendimento con 1-4 campi selezionati, IQ Bot cercherà almeno 4 campi

dal numero totale di campi presentati per quell'istanza di apprendimento specifica. Analogamente, se
crei una nuova istanza di apprendimento con 5 campi selezionati, IQ Bot cercherà almeno 5 campi.

• Se crei un'istanza di apprendimento con 6 o più campi selezionati nell'istanza di apprendimento, IQ Bot
cercherà almeno 6 campi. Ad esempio, se hai selezionato 8 campi in un dominio di fatturazione, IQ Bot
cercherà almeno 6 campi rispetto al totale dei campi disponibili.

Istanze di apprendimento create con altri domini

Se crei una nuova istanza di apprendimento con più campi, IQ Bot cercherà almeno un campo e
classificherà il documento. Se IQ Bot non trova alcun campo, il documento verrà contrassegnato come non
classificato.

Fattori che influiscono sulla classificazione

Fattore Note

Layout di pagina Se il layout di pagina differisce dal documento originale per
la posizione del contenuto del documento, IQ Bot invierà il
documento a un gruppo diverso.

Orientamento dell'etichetta Tutte le etichette di un documento devono essere orientate
nella stessa direzione. Se alcune etichette sono verticali e altre
orizzontali, il documento verrà inviato a un gruppo diverso.

Posizione dell'etichetta Le etichette possono essere posizionate in qualsiasi punto
della pagina. Tuttavia, la sequenza delle etichette da sinistra
a destra e dall'alto verso il basso deve essere la stessa dei
documenti di formazione.

Percentuale di corrispondenza IQ Bot utilizza una corrispondenza del 70% per le etichette.

Campi aggiunti dopo la creazione
dell'istanza di apprendimento

I campi aggiunti dopo la creazione di un'istanza di
apprendimento sono esclusi dal processo di classificazione.

Related tasks
Limit the creation of document groups on page 2494
Limit the number of new document groups that the Classifier can create when a learning instance is in
production.

Create a new document group
Manually define a user-created document group to process documents with an identical layout. For
example, invoices from a specific supplier.
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• If you have not done so already, Creare un'istanza di apprendimento on page 2487. After you create a
learning instance, you are redirected to the document groups page, where you create a new document
group.

• Identify the group label. This is the name of the folder in the documents\classify\train directory
where documents with an identical layout are sent. You will provide the group label in the steps below.

• Identify sample documents (maximum 150) that have an identical layout. You can upload more
documents to train the group after the group is created.

1. Navigate to the learning instance details page and click Create group.
2. In the Group label field, provide the folder name that contains the sorted documents in the

documents\classify\train directory.
3. Click Browse to upload sample documents to define the layout.
4. Fai clic su Salva.

1. Configure the mechanism to sort incoming documents to the correct group:
• To use the Classifier, run the bot with the Train Classifier action to create the classification model

and sub-folders to hold the sorted documents in the documents\classify\train directory.
Consulta Using Train Classifier action on page 1644.

• Alternatively, create RPA bots identify and sort incoming documents using conditional statements,
such as string-matching the file name or sender. See the String condition in the Loop package on
page 1681 or If package on page 1625.

2. Update the following actions:
• Facoltativo: Update the Classify Document action to use Express mode. See step 6 in Using

the Classify document action on page 1643.
• Update the Upload document action to provide the group label. See step 4 in Upload document

action on page 1663.

3. Upload more documents to train the group. When you are done with training, set the group to
production.

4. After you set the group to production: If you have a bot with the Process Documents action,
you must update the action with the group label. See step 7 in Utilizzo dell'action Elabora documenti IQ
Bot on page 1661.

Note:  During the production process, you must not move the learning instances or bots from Staging
to Production or vice-versa.

Creare un'istanza di apprendimento
Create a learning instance and upload sample documents for training. In this step, you define the data
elements for a single document type, such as an invoice or a purchase order, and the fields which you
want to extract.
Ensure the sample documents meet the following requirements:
• Each document is a separate file. For example, if you have downloaded an email and its attachments

into a single PDF, you must separate the email body from the attachments. Consulta Using the Split
document action on page 1739.
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• The documents are in one of the following supported file types:
• PDF
• JPG
• JPEG
• PNG
• TIFF

• Consigliamo di utilizzare documenti con un valore di risoluzione di almeno 300 punti per pollice (dots
per inch, dpi).

• In staging, you can upload a maximum of 150 documents of 10 MB file size per learning instance.
• In production, you can upload a maximum of 50 MB file size per document. However, the maximum

number of documents allowed per learning instance depends on the license.
• There are no limitations on the number of pages per document in a pdfbox OCR.
• You can upload 60 pages per document in an image-based OCR.
• You can upload up to a file size of 12 MB. You can upload additional documents after creating the

learning instance.
• The file names of the documents that you upload should not start with special characters, such as the

hyphen (-).

Note:
• With the Tesseract4 OCR, currently there is a known limitation which restricts the number of pages per

document to less than 60 pages.
• Confidential computing di Azure consente alle organizzazioni di caricare i dati crittografati in un archivio

protetto, ad esempio cartelle private su una macchina virtuale. Se si caricano documenti da tali cartelle
protette su IQ Bot, questi vengono portati in stato Non classificato in quanto l'estrazione dei dati non
è supportata per tali documenti.

When you start with a collection of documents to insert into a digital process, you will probably have a
mix of documents types, formats, and orientations. An invoice, for example, has a consistent set of data
elements, whereas a purchase order contains a different set of data elements. You must create a different
learning instance for each of these document types, using the following steps:
1. Navigate to LEARNING INSTANCES and click the New instance option.
2. Nella schermata Crea nuova istanza di apprendimento, immetti le seguenti informazioni:

a) Nome istanza: Immetti un nome univoco.
IQ Bot version A360.21 and below does not allow duplicate learning instance names. Anche se
elimini un'istanza di apprendimento, il nome non può essere riutilizzato. From IQ Bot version
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A360.22, it is possible to create duplicate learning instance names, as well as reuse the name of
a deleted learning instance.

b) Optional: Descrizione: Immetti una descrizione.
c) Tipo di documento: Select the document type from the drop-down list.

Do not choose standard forms as Document type while creating learning instance. Based on
the option you select, a predefined set of form and table fields for the domain type appears. For
example, when you select Invoices, the common forms and tables of an invoice appear.

Note:  If you want to create a domain to use specifically for this learning instance, select
Document type > Other and enter a domain name. In the upcoming steps, you will customize
the domain.
For more information on creating a custom domain, watch the following video:
If you want to create a domain to use in more than one learning instance and you have the
required access permissions, you can work with Automation Anywhere support to create a custom
domain. Per ulteriori informazioni, vedi Custom domains in IQ Bot on page 2536.

d) Lingua principale dei documenti: Puoi utilizzare il menu a discesa per selezionare una lingua
per l'istanza di apprendimento.
Languages supported in Automation 360 IQ Bot on page 2481
Per creare domini personalizzati in altre lingue e accedere a un massimo di 190 lingue supportate
da IQ Bot, contatta l'assistenza Automation Anywhere.

Important:  If you are unable to see all languages in the IQ Bot interface, troubleshoot the
issue: Unable to extract data from Multiple languages in a document (A-People login required)

e) Carica i tuoi documenti: Click the Browse option to upload sample documents.

3. Select or de-select fields in the Common form fields and Common table/repeated sections
fields sections.
Form fields appear one time in a document, such as the invoice date or number. Table fields are fields
that reoccur throughout the document, such as the item total or quantity.
To see all the possible fields, click Additional form fields or Additional table/repeated section
fields.

4. Optional: Add additional fields by entering the field name in the Additional form fields or
Additional table/repeated section fields section.
Follow the naming conventions when you enter a name in the Add fields (Optional) field:
• I nomi di campo possono iniziare solo con caratteri alfabetici (A-Z e a-z).
• I nomi di campo possono includere solo caratteri alfanumerici e spazi.
• Field name cannot end with a space.

5. Riconoscimento ottico dei caratteri: Select the required OCR engine.
Selezione di un motore OCR on page 2490

6. Optional: De-select the My PDF documents do not have images check box. To learn more, see
Disabilitazione dell'opzione PDFBox on page 2497
When this check box is selected, IQ Bot uses PDFBox OCR to process PDF documents; non-PDF
documents are processed by the OCR you selected in the previous step.

7. Rilevamento automatico casella di controllo: Seleziona la casella di controllo Rileva caselle di
controllo per attivare questa funzione.
La selezione di questa opzione consente a IQ Bot di rilevare automaticamente le caselle di controllo di
un documento. Tuttavia, questo potrebbe aumentare il tempo di elaborazione dei documenti.
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8. Fai clic sull'opzione Crea istanza e analizza per creare l'istanza di apprendimento.
Il sistema analizza e ordina i documenti di formazione in gruppi logici in base all'identificazione del
campo e mostra i dettagli nella scheda Istanza di formazione > Riepilogo.

When a new learning instance is created, the sample documents you uploaded are analyzed and sorted
into groups based on the document characteristics. Per ulteriori informazioni, consulta Informazioni sul
Classificatore on page 2484.
After the Classifier finishes sorting the documents, you are redirected to the Designer, where you will train
bots to extract data from each sample document. Formare un'istanza di apprendimento on page 2498.
Related tasks
Selezione di un motore OCR on page 2490
You can select an OCR engines that suits your requirement for data extraction based on your document
types. Restarting IQ Bot services is not necessary for implementing an engine change.
Related reference
Create a learning instance for standard forms on page 2549
Learning instance is used in IQ Bot to extract, train, validate content from standard forms. Use the
following instructions to create a learning instance for processing standard forms in IQ Bot

Selezione di un motore OCR
You can select an OCR engines that suits your requirement for data extraction based on your document
types. Restarting IQ Bot services is not necessary for implementing an engine change.
Durante l'installazione di IQ Bot, il sistema imposta la versione di Tesseract Optical Character Reader
più recente come motore OCR predefinito. This is also the default setting for the product. Tuttavia, puoi
impostare manualmente il motore OCR nel file Settings.txt, facendolo diventare il motore predefinito.
Analogamente alle versioni precedenti di IQ Bot, puoi continuare ad aggiornare manualmente il file
Settings.txt con il nome del motore OCR che desideri impostare come predefinito.
When creating a learning instance, you can select an OCR engine from the Optical Character
Recognition drop-down menu. Vedi Creare un'istanza di apprendimento on page 2487

Note:  La selezione di un motore OCR nell'interfaccia sostituisce le impostazioni nel file Settings.txt.

The following table lists the various OCR engines supported in IQ Bot and the corresponding options:

Table 4: List of OCR engines and their specifications

Qualifiers Versione
OCR

Supported
installation

Handwritten Languages
Supported

Document
Quality

Tipo di
documento

Tesseract
OCR

4 Cloud e On-
Premises

N/D English
Tedesco
Spagnolo
Italiano
Francese

No noise
No dark
background
No stamps/
watermarks
200+ dpi

Invoices,
POs, etc.
Semi-
structured
formats
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Qualifiers Versione
OCR

Supported
installation

Handwritten Languages
Supported

Document
Quality

Tipo di
documento

ABBYY
FineReader
Engine

12.3, or 12.4 Cloud e On-
Premises

N/D English
All Latin+
Chinese
Giapponese
Coreano

Less noise
Dark
background
with white
fonts
Has stamps/
watermarks
96+ dpi

Invoices,
POs, etc.
Semi-
structured
formats
Mortgage
Forms, Tax
Forms
Unstructured
Formats

Microsoft
Azure
Computer
Vision OCR
engine

2,0 o 3,2 Cloud e On-
Premises

English only English
All Latin+
Chinese
Giapponese
Coreano

Less noise
Dark
background
Has stamps/
watermarks
96+ dpi

Invoices,
POs, etc.
Semi-
structured
formats
Passports,
Driving
license, etc.
Documenti
KYC

Google
Vision API

Version is
updated
automatically
to match
current
release

Cloud e On-
Premises

N/D English
All Latin+
Asian

Less noise
Dark
background
Has stamps/
watermarks
96+ dpi

Invoices,
POs, etc.
Semi-
structured
formats
Mortgage
Forms, Tax
Forms
Unstructured
Formats

Tegaki API Check with
your Cogent
Labs sales
representative

On-Premises
only

Japanese
and Korean

Japanese
and Korean

No noise
No dark
background
No stamps/
watermarks
200+ dpi

Invoices,
POs, etc.
Semi-
structured
formats

1. On the Create a new learning instance page, select the domain and language of the documents.
Nella pagina di elenco Le mie istanze di apprendimento, è disponibile una nuova colonna
Motore OCR che mostra il motore OCR utilizzato per creare ogni istanza di apprendimento. Queste
informazioni sono utili per l'utente quando decide l'elaborazione del documento.
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2. Le sezioni Campi da estrarre e Impostazioni avanzate vengono visualizzate quando si seleziona il
dominio.
Ogni dominio è disponibile con un elenco predefinito delle principali lingue supportate. La selezione
della lingua è abilitata e disponibile dall'elenco a discesa Lingua principale dei documenti in base
alle lingue supportate per un dominio specifico.

Note:  Se selezioni una lingua dall'elenco a discesa Lingua principale dei documenti, quindi
selezioni un motore che non supporta tale lingua, il sistema visualizza un messaggio di errore
nell'elenco a discesa Riconoscimento ottico dei caratteri.

3. Click Advanced Settings > Optical character recognition to display the OCR engine options
drop-down list.
Se la selezione del motore OCR non è valida, l'opzione Crea istanza e analizza non è abilitata.

Note:  IQ Bot installa automaticamente tutti i motori OCR durante il processo di installazione, ad
eccezione di ABBYY FineReader Engine.

Important:  Puoi configurare il motore OCR selezionato solo in Automation 360 IQ Bot On-Premises.
Le impostazioni OCR in Automation 360 IQ Bot Cloud non possono essere modificate poiché non sono
accessibili eccetto per ABBYY FineReader Engine. Puoi modificare le impostazioni di configurazione di
ABBYY FineReader Engine utilizzando l'API REST appConfigurations.

Puoi effettuare selezioni dalle seguenti opzioni:

Opzione Descrizione

Tesseract OCR 4 Questo è il motore predefinito, a meno che non venga modificato
nel file Settings.txt.

ABBYY FineReader Engine Per verificare se ABBYY FineReader Engine è installato e disponibile
per l'uso sul computer, controlla il file Settings.txt, la cartella
Plug-in OCR per i file SDK e l'elenco a discesa Riconoscimento
ottico dei caratteri.

Note:  Supportato anche in IQ Bot [Local Device] package e IQ Bot
Extraction package.

Utilizzo del motore ABBYY FineReader Engine OCR in IQ Bot on page
1101

Microsoft Azure Computer
Vision OCR engine

IQ Bot supporta tutte le lingue supportate da questo motore OCR.
Utilizzare Microsoft Azure Computer Vision OCR engine on page 1098

Google Vision API IQ Bot supporta Google Vision API come motore OCR e supporta
tutte le lingue supportate da questo motore.
Utilizzo del motore Google Vision API OCR on page 1104

Tegaki API IQ Bot supporta il suo motore OCR per estrarre dati specifici per
documenti in lingua giapponese e coreana. È necessario scaricare e
utilizzare la propria licenza privata per utilizzare Tegaki API.

Note:  Il motore Tegaki API OCR non è supportato in Automation
360 IQ Bot Cloud.

Utilizzo del motore Tegaki API OCR on page 1107
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Opzione Descrizione

I miei documenti PDF non
hanno alcuna immagine

Tutti i documenti PDF caricati vengono elaborati utilizzando il OCR
PDFBox per impostazione predefinita, indipendentemente dal
motore OCR specificato o selezionato.
Se stai caricando documenti non PDF o PDF che contengono
immagini, deseleziona la casella di controllo I miei documenti
PDF non contengono immagini per assicurarti che per elaborare
i documenti venga utilizzato il motore OCR specificato o selezionato.
La casella di controllo I miei documenti PDF non contengono
immagini è abilitata per impostazione predefinita. Per disabilitare
questa funzione, vedi Disabilitazione dell'opzione PDFBox on page
2497.

Tip:  se IQ Bot non è in grado di estrarre i dati da documenti di bassa qualità o scritti a mano, devi
risolvere il problema:
IQ Bot unable to extract data from low quality and Handwritten documents (A-People login required)

Note:  Use the following files to change the OCR settings:
• AbbyyImagePreProcessingSettings.json
• LangugeCodeToAbbyyLanguageCode.json
• TegakiOCREngineSettings.json
• Azure3OCREngineSettings.json
• GoogleOCREngineSettings.json
• AzureOCREngineSettings.json

How to change OCR Settings in IQ Bot (A-People login required)

Modificare un'istanza di apprendimento
Modificare un'istanza di apprendimento per modificarne il nome, la descrizione, aggiungere documenti di
formazione aggiuntivi o includere campi aggiuntivi per l'estrazione.
È possibile modificare solo un'istanza di apprendimento in gestione temporanea. Quindi, assicurati di
spostare qualsiasi istanza di apprendimento nell'ambiente di produzione in gestione temporanea per
modificarla.
1. Nella pagina Istanze di apprendimento, fai clic su un'istanza di apprendimento.
2. Fai clic sull'icona Modifica per modificare l'istanza di apprendimento.
3. Optional: Aggiorna il campo della descrizione (facoltativo).
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4. Optional: Modificare o aggiornare il nome dell'istanza di apprendimento.
Quando si modifica il nome di un'istanza di apprendimento, si verificano le seguenti modifiche:
• Nella directory di output configurata viene creata una cartella separata con il nome della nuova

istanza di apprendimento per memorizzare i file .csv dei documenti elaborati.
La cartella precedente contenente i file .csv prima che il nome dell'istanza di apprendimento
venisse modificato rimane com'è nella cartella di output.

• Quando si esegue la migrazione di un'istanza di apprendimento con un nome aggiornato utilizzando
le opzioni di sovrascrittura o rimozione, questa viene aggiornata nell'ambiente di origine dopo
l'importazione del file .iqba.

• Per questa attività viene creata una voce nei registri di controllo.

5. Optional: Fai clic su Sfoglia per selezionare altri documenti di formazione.
The file names of the documents that you upload should not start with special characters, such as the
hyphen (-).

6. Optional: Seleziona altri campi e colonne di tabella che desideri aggiungere all'istanza di
apprendimento per l'estrazione dei dati.

7. Utilizza il campo Impostazione per la creazione di nuovi gruppi per limitare la creazione di nuovi
gruppi o impostare la soglia per il numero di gruppi.

Note:  The New groups creation setting field only applies to the documents in Production.
However, this field option is not applicable for IQ Bot [Local Device] and IQ Bot Extractionpackages.

Per ulteriori informazioni, consulta Limit the creation of document groups on page 2494.
8. Optional: Utilizza l'opzione Gruppo convalide predefinito per selezionare un gruppo predefinito per

le convalide dei documenti.
Tutti i nuovi documenti utilizzano la logica personalizzata e le convalide definite nel gruppo predefinito.
Le regole di convalida di questo gruppo predefinito vengono applicate quando un documento non
appartiene a nessuno dei gruppi esistenti. If you delete the selected default group, the validation rules
are not applied to any of the new documents that were supposed to use this group.

Note:  Se si seleziona un gruppo predefinito, è possibile modificarlo solo in un altro gruppo. Tuttavia,
non è possibile selezionare Seleziona convalida predefinita, che è l'impostazione predefinita.

9. Fai clic su Salva per visualizzare un messaggio di conferma.
10. Fai clic su Sì, procedi con l'aggiunta del campo per caricare, analizzare e classificare i documenti

di formazione selezionati (se presenti) aggiunti all'istanza di apprendimento.
I campi appena aggiunti non alterano la classificazione dei documenti.

Tutti i campi aggiuntivi diventano disponibili in tutti i bots e sono visualizzati come campi facoltativi
nell'istanza di apprendimento selezionata. bots deve essere nuovamente formato per questi campi.
Consulta Errori generati durante la modifica delle istanze di apprendimento on page 2496.

Limit the creation of document groups
Limit the number of new document groups that the Classifier can create when a learning instance is in
production.
You can only edit a learning instance that is in staging. If the learning instance is in production, you must
revert it to staging.
Quando i documenti vengono caricati in un'istanza di apprendimento, il Classificatore li ordina in gruppi
di documenti basati sul layout, cioè l'ordine in cui i campi appaiono sulla pagina. Se un documento viene
caricato in un'istanza di apprendimento in produzione e il documento non corrisponde al layout di nessuno
dei gruppi di documenti, il Classificatore crea un nuovo gruppo per quel documento.
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Use the following steps to either configure a limit for the number of total document groups in the learning
instance, or opt to disallow the Classifier from creating new document groups.
1. Navigate to LEARNING INSTANCES, select a learning instance, and click Edit.
2. Scegli tra le seguenti opzioni:

Opzione Descrizione

Seleziona la casella di controllo Non creare
mai nuovi gruppi

Non vengono creati nuovi gruppi,
indipendentemente dal numero di
caricamenti dei documenti. I documenti
caricati vengono inviati direttamente a
Validator.
• Per impostazione predefinita, questa

casella di controllo è deselezionata.
• Quando questa opzione è selezionata,

il campo Soglia per la creazione di
nuovi gruppi è disattivato.

• Puoi creare nuovi gruppi manualmente
caricandoli nell'istanza di apprendimento
in gestione temporanea.

Imposta un valore per il campo Soglia per
la creazione di nuovi gruppi

Quando imposti un valore di soglia, IQ
Bot non crea un gruppo per i documenti
caricati fino a quando non raggiunge il
valore definito. Fino al raggiungimento del
valore di soglia impostato, tutti i documenti
vengono inviati a Validator.
• Per impostazione predefinita, il valore

è impostato su 10 per tutte le nuove
istanze di apprendimento.

• Puoi impostare un valore che contenga
un massimo di 10 cifre.

• IQ Bot non consente di immettere
caratteri non numerici, zero o virgola
mobile.

3. Salva gli aggiornamenti, che vengono quindi riportati nella scheda Riepilogo.
Nella scheda Riepilogo vengono visualizzati tutti i dettagli relativi alla gestione temporanea e alla
produzione. Le informazioni vengono aggiornate in base a qualsiasi impostazione applicata nella
sezione Impostazioni per la creazione di nuovi gruppi.
Per le nuove istanze di apprendimento, a meno che si imposti la soglia minima nella sezione
Impostazioni per la creazione di nuovi gruppi, IQ Bot applica il valore predefinito impostato di
10 e non creare gruppi per i primi 9 documenti caricati.

4. For existing learning instances, you can set the minimum threshold in the Learning Instance > Edit
page. La nuova soglia viene applicata a tutti i documenti da quel momento in poi.
Tutte le istanze di apprendimento esistenti, anche dopo l'aggiornamento, continueranno con una soglia
pari a 1.
Tutte le modifiche hanno effetto solo sui documenti caricati in produzione dopo la modifica
dell'impostazione. Se modifichi l'impostazione in una nuova soglia o non crei nuovi gruppi con
un'istanza di apprendimento esistente, questo controllo verrà eseguito solo sul documento successivo
caricato in produzione.
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Nell'ambiente di produzione tutti i documenti classificati, che non appartengono ad alcun gruppo e che non
soddisfano il requisito di soglia minimo vengono inviati a Validator. Puoi aggiornare i valori e apportare le
correzioni necessarie. Tuttavia, tutti i campi sono facoltativi e sono tipi di dati testo. L'utente può Salvare
il documento corrente senza apportare correzioni o scegliere l'opzione Contrassegna come non
valido.

Errori generati durante la modifica delle istanze di apprendimento
Questo argomento descrive gli scenari dei caso d'uso e i messaggi di errore generati durante la modifica di
un'istanza di apprendimento.

Caso Dettagli Messaggio

Bot in formazione L'istanza di apprendimento è
in uso in quanto è in corso la
formazione dei bot e modifichi
la stessa istanza
A) L'utente 2 sta modificando la
stessa istanza di apprendimento

Caso 1: modifica simultanea
della stessa istanza di
apprendimento

Esempio per il caso 1:
L'utente 1 carica un documento
nella stessa istanza di
apprendimento.
L'utente 2 aggiunge un campo
durante la modifica della stessa
istanza di apprendimento.
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Caso Dettagli Messaggio

Esegui e modifica lo stesso bot Esegui il bot, quindi modifica lo
stesso bot utilizzando lo stesso
accesso utente o due accessi
utente differenti.

Eliminare un'istanza di apprendimento
Utilizza la pagina Istanze di apprendimento per eliminare un'istanza di apprendimento dalla pagina
Visualizza dettagli.
Non puoi eliminare un'istanza di apprendimento che si trova nell'ambiente di produzione. Per modificare
un'istanza di apprendimento, procedi nel modo seguente:
1. Nella pagina Istanze di apprendimento, fai clic sull'istanza di apprendimento o sull'icona

Visualizza i dettagli dell'istanza per visualizzare la scheda Riepilogo.
2. Nella pagina dei dettagli, : fai clic sull'icona Modifica. L'istanza di apprendimento diventa disponibile

per la modifica.
3. Per eliminare l'istanza di apprendimento, fai clic sul pulsante Elimina istanza. Viene visualizzato un

messaggio di conferma.
4. Immetti il nome dell'istanza di apprendimento nel campo ed eliminala.

Important:
A meno che l'istanza di apprendimento non sia già stata esportata come backup, una volta che un'istanza
di apprendimento viene eliminata:
• Viene eliminata definitivamente e non può essere ripristinata.
• Tutti i bots a essa associati vengono eliminati e non possono essere riutilizzati.
• Non puoi riutilizzare un nome eliminato per un'istanza di apprendimento per crearne una nuova.

Disabilitazione dell'opzione PDFBox
L'opzione PDFBox è abilitata per impostazione predefinita. Puoi disabilitare l'opzione durante la formazione
di documenti PDF ibridi contenenti immagini e testo.
L'opzione PDFBox funziona al meglio solo con documenti completamente digitali. Se utilizzi documenti ibridi
contenenti immagini e testo, è consigliabile disabilitare l'opzione PDFBox per una migliore classificazione
dei documenti.
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Note:  L'opzione PDFBox è abilitata nel sistema per impostazione predefinita. Ensure that the PDFBox is
kept enabled only if you plan to process digital documents, otherwise processing will fail.

If PDFBox is enabled, you can process the following PDF types:
• Vector and Hybrid PDF can be processed using PDFBox
• Raster PDF can be first processed using PDFBox, and if no segment is found then the PDF is processed

again using Document Image OCR

Sono disponibili due modi per disabilitare/abilitare l'opzione PDFBox in IQ Bot:
• Direttamente nell'interfaccia utente durante la creazione di un'istanza di apprendimento. In the Create

new learning instance page go to Advanced Settings > Optical character recognition and
disable/enable the My PDF documents do not have images check-box.

• In the Setting.txt file described as follows:

1. Navigate to C:\Program Files (x86)\Automation Anywhere IQ Bot\Configurations.
2. Open the Setting.txt file, and change PDFBoxOCREnabled=true to

PDFBoxOCREnabled=false

Questa modifica disattiva l'elaborazione dei documenti caricati da PDFBox per le nuove istanze di
apprendimento (dopo averla applicata) e non si applica alle istanze di apprendimento esistenti. IQ Bot
utilizzerà anche il motore OCR selezionato per i documenti PDF.

Note:  Quando PDFBox è disabilitato, assicurati che il documento PDF sia inferiore a 60 pagine.

3. After updating the Setting.txt file, execution of stoppedanduninstalled and
installedandstartedstart of IQ Bot services is not required.

Formare un'istanza di apprendimento
Use the staging environment to train a learning instance and extract data from sample documents. Review
each field to verify whether the correct value is extracted and where necessary, map the correct field.
When you upload sample documents while creating a learning instance, the Classifier analyzes and
categorizes these documents into logical groups. The system creates a bot for each document group,
which you must train to extract data from specific fields in the sample documents.
The following steps provide an overview of the training process:

Passaggio 1: Open the Designer From the My Learning Instances page, open a
learning instance and click Edit bot or Create bot
to start training the learning instance.
For an introduction to the components, see
Introduction to the Designer on page 2500.

Passaggio 2: Map the document fields In the Fields section, click each form field to verify
whether the correct value is extracted. If the value
is incorrect or if the field was not found (indicated
by a grayed-out check icon next to the field), you
must remap the field.
• Mappare un campo on page 2504
• Eliminazione della mappatura in Designer on page

2511

© 2023 Automation Anywhere. All rights reserved.     2498



    Automation Anywhere - Digitalizzazione

Passaggio 3: Map the check boxes (if
applicable)

If you configured the learning instance and
uploaded sample documents containing check
boxes or option buttons, see Extract data from check
boxes or check box groups on page 2509

Note:  Check boxes and check box groups can be
extracted as either a form or table field depending
on whether the check box appears one time or on a
recurring basis in the document.

Passaggio 4: Map the table fields Review each table field to ensure that the correct
column name is identified in the Column Value
field. If IQ Bot did not find the correct Column
Name, remap the column name by using the same
approach as you did for the form fields. Then,
configure the table settings. Mappare una tabella on
page 2506
If the document contains more than one table,
define the additional tables:
1. Add all the table fields to the Additional

table/repeated fields section of a learning
instance. Modificare un'istanza di apprendimento
on page 2493.

2. Map the additional table fields. Add multiple
tables in Designer on page 2508.
To establish a relationship between the fields
of the different tables, see Definizione di uno o
più campi collegati in una tabella figlio on page
2508.

Passaggio 5: Review the training results Click See extraction results to check the
extracted data from the document group.
Visualizzare in anteprima i dati estratti on page 2510
If not all of the fields are extracted, try resizing the
mapping areas for those fields.
Alternatively, train the bot by using a different
document. Change the training document for a group
on page 2501

Passaggio 6: Save the bot Click Save and go to next group to train the bot
for the next document group.
A menu appears, with the option to Cancel, Save,
or Save and send to Production.

Note:  We recommend that you test the bot (see
next step) before sending it to production.

You can view the status of all the bots in all your
learning instances from the BOTS tab. Manage IQ
bots

Passaggio 7: Test bot extraction capabilities Navigate to the BOTS tab and click Test bot.
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The bot processes the remaining documents in the
document group based on the trained document. To
see the bot performance, review the values in the
Learning instance summary page, particularly
the straight-though processing (STP) metric. Review
the learning instance details on page 2511
If the STP number is low, you can either retrain the
bot, such as by resizing the mapping areas or train
the bot on a different document. Change the training
document for a group on page 2501

Passaggio 8: Send the bot to production When you are satisfied with the extraction accuracy
of the bot, switch it to production mode. Then,
switch the learning instance to production mode.
Once a learning instance is in production mode, IQ
Bot is ready to begin processing documents in real
time: classifying the uploaded documents to the
document groups with bots in production and either
extracting data or sending the document for manual
validation.
From the Learning Instance Details page, click
the switch at the top right to move the learning
instance into production mode. Impostazione di
un'istanza di apprendimento su Produzione on page
2527

Note:  If you want to retrain a bot, both the
learning instance and the bot must be in staging
mode.

Related concepts
Informazioni sul Classificatore on page 2484
Impara come vengono classificati i documenti e i fattori che influenzano la classificazione.

Introduction to the Designer
The Designer is the user interface where you train bots to extract data from uploaded sample documents.
The Designer contains auto-mapped fields and table columns, where you can you edit the existing
mapping or add new fields and tables.
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Highlighted areas are:
1. Fields panel: List of fields selected for extraction during Learning Instance creation. Fields

successfully found are indicated with a green check mark.
2. Field Details panel: Details for the highlighted field in the Fields Panel, including data type and

extracted value.
3. Document Image panel: Rendered image of the document with image view controls
4. Form fields: A field that has a single value in the document, such as the invoice number or invoice

date.
5. Table fields: A field with values that appear more than one time in a document, such as the item

description or quantity.
6. The blue boxes indicate System Identified Regions (SIRs) where IQ Bot found extractable data.
7. The training document can be changed by clicking View each Group (#) document.
8. The extraction can be tested using See extraction results.
9. Save and close: Saves the changes and returns to the Learning Instance details page.
10. Save and go to the next group: Saves changes, allows the Group to be set to Production mode,

and moves to the next available Group.

Note:  If you have multiple files in a group and one of the document is deleted, then you will see an error
message Unable to load document and you will not be able to change the document for training in the
Designer. When the entire multi-page document is deleted or corrupted, you will not be able to navigate
between the pages. If you click the next page button, then the Loading document screen is displayed.

Change the training document for a group
Durante la formazione di un documento, un utente può esaminare i layout di documenti univoci disponibili
in un gruppo e scegliere un documento diverso da quello predefinito selezionato da IQ Bot Designer, che
meglio rappresenta i documenti in quel gruppo. Questo aiuta a ottimizzare il processo di elaborazione
interamente automatizzata (Straight Through Processing, STP).
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Per scegliere un documento diverso da un gruppo di documenti, attieniti a questa procedura.
1. L'utente può vedere il pulsante Visualizza ciascun documento del Gruppo 'x' nella pagina di

formazione di Designer accanto al nome del documento.
Il pulsante Visualizza ciascun documento del Gruppo 'x' è disabilitato se nel gruppo è presente
un singolo documento.

2. Fai clic sul pulsante Visualizza ciascun documento del Gruppo 'x' per visualizzare le frecce Avanti
e Indietro che consentono di passare a un altro documento. Puoi anche annullare l'attività.
La scelta di un documento diverso come documento di formazione del gruppo cancellerà tutta la
mappatura dal documento precedente. IQ Bot visualizza un messaggio di avviso corrispondente.

3. Seleziona un nuovo documento e fai clic sul pulsante Modifica il documento di formazione
per visualizzare il seguente messaggio di conferma: Se modifichi il documento di
formazione per questo gruppo, qualsiasi mappatura del documento che è stato
precedentemente oggetto di formazione andrà persa. Modificare il documento
di formazione per <group name> in <document name>?

4. Selezionando No, annulla, torni a Designer, mentre se confermi il messaggio con Sì, modifica, il
sistema carica e avvia il nuovo documento con campi mappati automaticamente.

5. Fai clic su Guarda i risultati dell'estrazione per visualizzare i dati estratti dal nuovo documento.

Attività eseguite dalla pagina Bot
This page lists all the available bots for a learning instance, and enables you to perform tasks such as run,
change the status, or launch the IQ Bot Designer.
Crea un bot, per estrarre il testo da un documento. Definisci le etichette e i valori dei campi di un
documento in modo che il sistema possa apprenderli ed elaborare automaticamente altri documenti nel
gruppo di documenti.
Monitora l'avanzamento e lo stato di tutti i bots creati per un'istanza di apprendimento e imposta lo stato
da Gestione temporanea in Ambiente di produzione.

Il test di un bot consente di verificare se il bot è in grado di raggiungere il livello di accuratezza desiderato
in base alla formazione. Consente inoltre di eseguirlo rispetto a tutti i documenti di esempio correlati con
tale categoria/gruppo e di confrontare l'accuratezza dei campi e del documento. Nell'ambiente di gestione
temporanea puoi eseguire test di un solo bot.

Note:
• Per visualizzare il documento aggiornato e la precisione del campo, aggiorna la pagina Bot e fai clic sul

nome del bot. Il documento caricato e l'accuratezza dei campi vengono visualizzati nell'area dei dettagli.
• Non puoi modificare un bot che un altro utente sta già modificando.

Vari stati bot

Lo stato di un bot dipende dallo stato dell'istanza di apprendimento e dal bot stesso. La tabella seguente
mostra la relazione tra lo stato dell'istanza di apprendimento, lo stato del bot e il bot.

Stato dell’istanza
di apprendimento

Stato del bot Status del bot

Gestione temporanea Gestione temporanea Formazione

Gestione temporanea Produzione Pronto
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Stato dell’istanza
di apprendimento

Stato del bot Status del bot

Produzione Gestione temporanea Formazione

Produzione Produzione Attivo

Creato Non creato Non in elenco

Eliminare un bot

Di seguito sono riportati alcuni punti chiave:
• Facendo clic sul pulsante Elimina bot viene visualizzato un messaggio che chiede se si desidera

eliminare il Bot. Selezionando Sì viene visualizzato un messaggio di operazione riuscita nella pagina dei
dettagli Istanza di apprendimento. La scheda Riepilogo mostra le informazioni aggiornate nelle sezioni
Gestione temporanea e risultati di Produzione per i campi Gruppi trovati e Bot creati.

• Puoi eliminare un Bot solo in Gestione temporanea. Una volta eliminato, il Bot non viene visualizzato
nella pagina dei dettagli Istanza di apprendimento o nella pagina di elenco del Bot.
• Tutti i documenti in gestione temporanea associati vengono rimossi dal sistema.
• Tutti i documenti di produzione non elaborati associati vengono spostati in Validator per

l'elaborazione.

Note:  Un nuovo Bot viene creato quando gli stessi documenti vengono caricati di nuovo nella gestione
temporanea o in produzione.

• Quando si ricaricano i documenti eliminati dall'istanza di apprendimento, il sistema classifica i documenti
e visualizza nuovamente i gruppi con l'opzione Crea bot per ogni gruppo. Facendo clic sull'opzione
Crea bot si crea il Bot che può poi essere visualizzato nella pagina dei dettagli Crea bot.

• In caso di eccezioni di back-end, come l'interruzione dei servizi, il sistema non consente di eliminare i
Bot. Viene invece visualizzato un messaggio di errore che indica che si è verificato un errore imprevisto.

Related tasks
Creazione del primo bot on page 1059
Attieniti alla seguente procedura per creare il primo bot che stampa il messaggio Go be great!, la
versione Automation Anywhere di Hello World!

Miglioramento della qualità di output utilizzando l'attendibilità OCR
Puoi migliorare la qualità di output della piattaforma IQ Bot che utilizza l'attendibilità del riconoscimento
ottico dei caratteri (Optical Character Recognition, OCR) e della regione identificata dal sistema (System
Identified Region, SIR) confrontandola con una soglia predefinita.
La convalida basata sull'attendibilità è utile per un campo di tipo testo e per i campi data o numero,
in quanto aiuta a instradare un documento, con valori controversi, affinché una persona li controlli
nonostante i campi soddisfino i criteri di convalida impostati.

Abilitazione della convalida basata sull'attendibilità OCR

Note:  Questa opzione è applicabile solo se è stata selezionata la voce Tesseract OCR durante la creazione
dell'istanza di apprendimento.
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Questa funzionalità è disabilitata per impostazione predefinita. Per attivare questa funzione, apri il file di
configurazione Settings.txt disponibile in <IQ Bot Installation Folder>\Configurations
\ e imposta il valore soglia desiderato nella proprietà ConfidenceThreshold. For this example, set
the character-level confidence threshold value to 99, that is ConfidenceThreshold=99. Quando
questa funzionalità è disabilitata, il valore predefinito è impostato su 0, per indicare che la funzionalità è
disabilitata.

Note:  il valore soglia di attendibilità è applicabile uniformemente a tutte le istanze di apprendimento.

Come funziona la convalida basata sull'attendibilità OCR

In un documento, se l'attendibilità a livello di carattere nella SIR di un campo è inferiore a quella della
soglia di attendibilità impostata, la convalida per quel campo non riesce, con conseguente errore nel
documento.

Note:  Se un valore di un campo non riesce a causa di una regola di convalida (ad esempio, formato del
numero non valido) diversa dall'errore di convalida dell'attendibilità OCR, viene visualizzata la descrizione
comandi corrispondente e non la descrizione comandi per la bassa attendibilità.

Durante la formazione di un documento, un errore di convalida basato sull'attendibilità rispetto a un campo
compare in una casella arancione durante l'anteprima se non esistono altri errori di convalida per quel
campo. Altri errori di convalida hanno la precedenza sulla convalida dell'attendibilità a livello di carattere
OCR.

Troubleshoot:  Se il motore OCR non è in grado di identificare le SIR per i documenti PDF in lingua
cinese, risolvi il problema:
• Data objects (SIRs) are not identified by OCR for Chinese PDF documents (A-People login required)
• How to convert PDF files to TIFF files (A-People login required)

Mappare un campo
When you are training a learning instance, if a field value was extracted incorrectly or if the field was not
found, you must remap the field.
If you have not done so already, first create a learning instance with sample documents. Creare un'istanza
di apprendimento on page 2487
For an introduction to the components, see Introduction to the Designer on page 2500.
The Designer image display panel contains blue boxes that surround text, date, or number type data. Each
of these blue boxes is a system identified region (SIR) that indicates that IQ Bot has identified that region
as containing extractable data. Perform the following steps to map a field to teach IQ Bot to extract data
from that field (for example, the invoice number) from a specific region (for example, the top-right side of
SIR).

Note:  These steps apply only to text, number, and date data types. IQ Bot also supports check boxes. Per
ulteriori informazioni, consulta Extract data from check boxes or check box groups on page 2509.

1. Select a field and specify the data type from the Data type list.

Note:  If a field value contains a mix of letters and numbers, such as invoice number, select the Text
option.
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2. In the image display panel, click the field from where you want to extract data.
IQ Bot tries to identify and autopopulate the corresponding field value in the field details panel.

Tip:  Use the pipe symbol (|) to add field aliases, which represents alternative text that might be
present in an SIR. For example, if the recipient's information is in a field labeled Sold to in some of
the documents and in Ship to in other documents, enter Sold to | Ship to as the field label.

3. Optional: Drag the corners of the green-bounded box to resize the mapping area.
Alternatively, draw a new mapping area by holding and dragging the cursor.
When you resize any value region or create your own value region using select, its position is fixed
relative to the field label. Il valore per tale campo verrà sempre cercato in quella regione relativa.
Reset a fixed field region defined by the user in the autodetected mode by clicking the close button at
the top-right corner of the field.
For additional information, see What are the different ways to map form fields in IQ Bot (A-People login
required).

4. Optional: If the column value is not consistently available in the training documents, expand the Field
options section and select Optional.

5. Optional: Add validation patterns or custom logic.
Modelli di convalida di Designer on page 2513|Aggiunta di logica personalizzata per migliorare l'estrazione
automatica in produzione on page 2522

Review each field to verify whether the correct value is extracted. Then, proceed to mapping table fields.
Consulta Mappare una tabella on page 2506.

Utilizzare la convalida dell'elenco per migliorare la precisione di un campo di testo
L'impostazione delle convalide durante la definizione di qualsiasi campo o colonna di tabella nel corso della
mappatura della classe del documento consente di convalidare un campo o una colonna di tabella con i
parametri predefiniti, affinché sia possibile ricevere una notifica in caso di mancata corrispondenza durante
il processo di digitalizzazione dei dati.
Inserisci ciascun valore di testo in una riga separata.
• Il bot convalida il valore estratto del campo/della colonna di tabella rispetto a questo elenco predefinito

e verifica eventuali discrepanze rilevate durante la fase Guarda i risultati dell'estrazione.
• Oltre alla convalida, il processo consente anche di correggere automaticamente i valori estratti.
• Gli errori nella convalida sono contrassegnati da un bordo rosso e possono essere visualizzati nella fase

Guarda i risultati dell'estrazione. Sposta il cursore sopra l'errore per conoscere il tipo di errore.

Se il valore di convalida dell'elenco è Adam e il valore estratto è Adem, il valore estratto verrà corretto
automaticamente in Adam. In questo esempio, è presente una corrispondenza del 75% dei caratteri e la
soglia per la corrispondenza è almeno del 66%.

Utilizzare modelli/elenchi di convalida per contrassegnare le discrepanze nei dati
estratti
Utilizza modelli/elenchi di convalida per contrassegnare le discrepanze nei dati estratti e impedire che i dati
errati vengano elaborati.
Quando è stato esplicitamente specificato un modello di formato di data/numero, la data/il numero viene
automaticamente corretto.
Vedi i seguenti esempi:
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Tabella 5: Esempio di modello di formato di data

Dati OCR errati Modello Correzione automatica

15 10-2015 gg-mm-aaaa 15-10-2015

Tabella 6: Esempio di modello di formato numerico

Dati OCR errati Modello Correzione automatica

123 4567 9999999 1234567

Mappare una tabella
IQ Bot uses column names as reference points when extracting values from tables. As part of training a
learning instance in the Designer, you must map the column names and configure the table settings.
Create a learning instance and map all the form fields in the Designer. Mappare un campo on page 2504

1. Skipping the Table settings section, click the first table column in the Table fields section.
2. Click the name of the column from where you want to extract data in the image display panel.

There are two ways to map the column values:
• Option 1: For a basic table that is contained within one page, map the column name to the

Column value field.
• Option 2: If the table spans multiple pages, we recommend mapping the Column value field to

an entry in that column that has the greatest height and width among the entries in that column.

Depending on which mapping option you choose, IQ Bot autopopulates the Column value field in the
field details panel with either the name of the selected column or the value of the selected table entry.
In addition, the selected SIR in the document is highlighted with yellow color for easy identification.

3. Optional: Drag the corners of the green-bounded box to resize the mapping area.
Alternatively, draw a new mapping area by holding and dragging the cursor.
When you resize any value region or create your own value region using select, its position is fixed
relative to the field label. Il valore per tale campo verrà sempre cercato in quella regione relativa.
Reset a fixed-field region defined by the user in the autodetected mode by clicking the close button at
the top-right corner of the field.

Tip:  Per ulteriori informazioni, vedi How to map tables in IQ Bot (A-People login required).

4. Expand the Field options section and select Required or Optional. Utilizza il valore facoltativo se il
valore della colonna non è sempre disponibile nei documenti di formazione.

5. Optional: Provide validation patterns.
Modelli di convalida di Designer on page 2513

Configure the Table settings section. Ensure that you map all the other fields in the document before
populating this section.
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6. Review the selected option in the Best field for table/repeated section field. IQ Bot autodetects
the table field that best defines the height of the rows in the table. You can select a different column
from the list.
Altre colonne vengono estratte in riferimento a questa colonna. For example, if the Best field for
table/repeated section has five rows, then a maximum of five rows will be extracted from the other
columns.

Note:  Ensure that this field does not contain multiple lines or is empty.

7. Optional: Map a field label for the End of table indicator field to specify where to stop extracting
data from that table.
For example, an invoice might contain the subtotal, sales tax, and total in the table, but because each
of these fields has only one value per document, they should not be extracted as part of the table.
Provide the name of the first field that appears where the table ends, for example, Total or Grand
 Total.
Provide the value for the End of table/section indicator field in any of the following ways:
• In the Image display panel, select an SIR to populate that text value as the End of table/section

indicator.
• Alternatively, type a value directly into the End of table indicator/section field, in the middle

panel.

Tip:  Use the pipe symbol (|) to add field aliases, which represent alternative text that might be in an
SIR. For example, Subtotal | Subtotal Amounts refers to Subtotal OR Subtotal Amounts.

For an example of how to map one table for extraction in a document that contains multiple tables,
see Mapping a table in a page with many tables on page 2507.

8. If you mapped a table value for the Column value field (option 2 in step 2): Expand the
Advanced table options section and select Stop extraction at "end of table indicator".

9. Optional: Enter custom logic.
Aggiunta di logica personalizzata per migliorare l'estrazione automatica in produzione on page 2522

Click See extraction results to check the training results for table data and remap the fields if required.
Visualizzare in anteprima i dati estratti on page 2510

Mapping a table in a page with many tables
This example guides you in using the Extract Table Summary Rows and End of table indicator fields
to extract one table in a page that contains many tables.
If you have not already done so, create a learning instance and map all the form fields in the Designer.
Mappare un campo alla pagina 2504
In this example, a page in a document contains more than one table, but the objective is to extract only
one of the tables. L'utente sta formando un bot in Designer, con almeno una tabella con regioni duplicate
o simili corrispondenti a quelle di un'altra tabella. La funzionalità Estrai righe di riepilogo tabella non
influisce sull'estrazione dei dati indipendentemente dal fatto che l'utente specifichi il valore dell'Indicatore
di fine tabella.
1. Crea due tabelle con aree simili o duplicate. Ad esempio, una tabella con totale reclami e l'altra con

dettagli registro relativi a numero riga.
2. Mappa tutte le colonne della tabella correlate a numero riga.
3. Mappa tutte le colonne del valore senza etichetta tabella, ma relative a totale reclami.

La tabella Totali reclamo contiene aree duplicate o simili come un'altra tabella relativa a numero riga.
Quindi, la colonna importo fatturato è un'area duplicata per entrambe le tabelle.
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4. Mappa una colonna della tabella totale reclami con l'etichetta totale reclami, poiché è necessaria almeno
un'etichetta di colonna per l'estrazione dei dati di una tabella.

5. Fai clic su Guarda i risultati dell'estrazione per visualizzare le righe duplicate che hanno aree
duplicate o simili nella tabella totale reclami. Ad esempio, quando una singola pagina contiene più
record di totali reclami.

6. Fai clic sul pulsante Torna alla formazione per tornare alla pagina di formazione.
7. Navigate to Claim totals table > table settings, and check the box for Extract Table Summary

Rows label under Advance Table Options.
8. Immetti il valore per Indicatore di fine tabella e fai clic su Guarda i risultati dell'estrazione.
9. L'utente può visualizzare le righe tabella nella totale reclami relative solo a totale reclami.
10. Fai clic su Esporta in CSV per aprire il file.
11. L'utente può vedere la tabella relativa all'estrazione di totale reclami, come mostrato nell'anteprima.
12. Quindi, imposta l'istanza di apprendimento e bot alla produzione e carica alcuni file relativi al bot.

• Se il bot non presenta errori di convalida, l'utente può visualizzare la tabella totale reclami come da
mappatura nel file CSV di produzione.

• Se il bot presenta alcuni errori di convalida, l'utente può vedere la tabella totale reclami come da
mappatura in Validator.

Add multiple tables in Designer
If the sample documents contain more than one table, you must map the columns and configure the table
settings for each table.
Create a learning instance and map all the fields in the Designer. Mappare un campo on page 2504
Map the columns for the first table. Mappare una tabella on page 2506
Puoi aggiungere più tabelle in Designer per estrarre i loro valori e convalidarle. Sposta uno o più campi
tabella da una tabella all'altra per eseguire la formazione sull'estrazione. Per aggiungere tabelle, procedi
come segue:
1. In the Table fields panel, click Add Table.
2. Seleziona le colonne da aggiungere dall'elenco Colonne disponibili e fai clic sulla freccia per

aggiungerle all'elenco di colonne della nuova tabella.
3. Map the column names and values as you did for the first table, then configure the Table settings

section.

Risorse

Click See extraction results to check the training results for table data and re-map the fields if needed.
Visualizzare in anteprima i dati estratti on page 2510

Definizione di uno o più campi collegati in una tabella figlio
In Designer, definisci uno o più campi/sezioni collegati in una tabella figlio per collegare le tabelle padre e
figlio in modo flessibile.
Utilizza la funzione Campi collegati in una tabella figlio in Designer per creare collegamenti di tabella e una
gerarchia di collegamenti di tabella tra tabelle padre e figlio. Ciò consente l'estrazione efficiente dei dati dei
campi collegati, oltre a facilitare il collegamento tra le tabelle. L'estrazione di dati chiave esterni consente
solo le seguenti relazioni:
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• Collegamento di una singola riga padre a una singola riga figlio (collegamento uno a uno)
• Collegamento di una singola riga padre a più righe figlio (collegamento uno a molti)

Nota:  IQ Bot non supporta il collegamento delle caselle di controllo.

Utilizza questa funzionalità per i documenti con un elenco di nomi o ID con informazioni specifiche su
ciascuno. Ad esempio, i documenti di un'azienda elettrica con un elenco di clienti e le relative informazioni
di fatturazione/utilizzo. Oppure un documento con un elenco di nomi di studenti che visualizza il relativo
punteggio di test. Crea più tabelle e collega i campi comuni consentendo in tal modo un'estrazione dei dati
efficiente e accurata. IQ Bot supporta il collegamento di un massimo di 50 colonne senza limite di righe.
Tuttavia, l'estrazione dei dati da righe distribuite su più pagine non è supportata.
• Collegamento di campi/sezioni da una singola tabella padre a una tabella figlio:

Nella sezione Tabella/ripetuta di Designer, scegli uno o più campi/sezioni da una tabella padre da
collegare a una tabella figlio.
1. Fai clic su Impostazioni tabella nella tabella figlio, quindi fai clic su Collega campi tabella

e seleziona la tabella padre dall'elenco a discesa dei nomi delle tabelle. In questo modo
vengono visualizzate le opzioni di colonna disponibili nella tabella padre che puoi scegliere per il
collegamento.

2. Seleziona le colonne che desideri collegare e fai clic sulla freccia verso il basso per collegare le
colonne alla tabella figlio.

3. Le colonne collegate vengono visualizzate in Tabella figlio > Impostazioni tabella >
Collegata a (nome tabella).

4. Quando visualizzi l'anteprima dei dati estratti (fai clic su Guarda i risultati dell'estrazione), i
campi collegati della tabella padre compaiono nelle colonne all'estrema sinistra della tabella figlio.

• Collegamento gerarchico di campi/sezioni di più tabelle:
Quando colleghi le tabelle 1, 2 e 3 in una gerarchia, effettua il collegamento in modo tale che la
tabella 1 sia padre della tabella 2 e la tabella 2 sia padre della tabella 3. Tutte e tre le tabelle verranno
collegate. La tabella figlio 3 visualizza i campi collegati delle tabelle 2 e 1. IQ Bot supporta la gerarchia
che collega fino a sei tabelle alla volta.

Nota:  per la tabella 3, puoi scegliere solo i campi della tabella 2 che non provengono dalla tabella 1.

Quando visualizzi l'anteprima dei dati estratti per la tabella figlio 3 (fai clic su Guarda i risultati
dell'estrazione), le colonne all'estrema sinistra mostrano il campi collegati della tabella 1. Le colonne
successive mostrano i campi collegati della tabella 2.

Importante:  affinché il collegamento venga eseguito correttamente, la tabella figlio deve trovarsi allo
stesso livello o a un livello inferiore rispetto alla tabella padre.

Extract data from check boxes or check box groups
Train a bot to extract data from a single check box or a group of check boxes.
Una casella di controllo è un oggetto dell'interfaccia utente che consente di effettuare una scelta binaria:
seleziona o lascia deselezionato. IQ Bot supporta l'estrazione di dati da caselle di controllo o pulsanti
di opzione contrassegnati da un segno di spunta, una croce o un punto. Oltre alle caselle di controllo
quadrate e ai pulsanti di opzione rotondi, IQ Bot supporta i contorni a triangolo e a rombo.
When IQ Bot processes documents with a check box, it extracts either a Yes (check box selected) or No
(check box not selected) value.
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You can also combine multiple check boxes into a single group, for example a payment methods group
that contains check boxes for cash, credit card, and check. When IQ Bot processes documents with a
check box group, it includes the group name in the extraction results.
Recurring check boxes or groups
By default, IQ Bot extracts check box values as a form field. However, if a check box or group appears
on a recurring basis in the uploaded documents, you manually select the Column option so that IQ Bot
extracts the values as table fields. This enables IQ Bot to extract values from the subsequent occurrences.
Otherwise, IQ Bot will only extract the check box value the first time it appears.
1. Fai clic sul campo che desideri mappare nel riquadro di sinistra.
2. Nel pannello centrale, nel campo a discesa Tipo di dati, seleziona il valore come casella di

controllo o gruppo di caselle di controllo.
• To extract data from single check box or check box groups, click the Field label field and

then click the corresponding value in the document in the right pane.
• Extract data from recurring check box or check box groups, click the Column name field

and then click the corresponding value in the document in the right pane.

3. To extract the check box value, draw an outline around the check box excluding the value.
• For a single check box, use the Draw tool to draw over the check box or select the auto-

mapped check box segment.
• For a check box group, use the Draw tool to draw over the region covering all the check boxes

in that group.

4. For single check boxes or check box groups: Verify the extracted data either in the Field value
field in the Designer or click See Extraction Results to see the extracted data.
For recurring check boxes or check box groups: You can only view the extracted data by clicking
See Extraction Results; the extracted data is not shown in the Designer.

5. Opzionale: Per aggiungere una singola casella di controllo a un gruppo di caselle di controllo, seleziona
il valore desiderato dal menu a discesa Gruppo di caselle di controllo.

6. When you are done configuring the check boxes, click Save and close or Save and go to next
group.

Visualizzare in anteprima i dati estratti
Click See Extraction Results to review the extraction accuracy of the bot. This is the only way to see
extraction results for table data, since the Designer does not show extracted table data during training.
Alternatively, click Export to CSV to review the data in a CSV file.
The extraction result window displays the following information:
• Successfully mapped fields and the extracted values.
• Table headers and the values for each row.
• Extraction errors, which are highlighted within a red box. Hover on the error to learn more, such as if

there was a validation error or lack of OCR confidence.

Note:  The time required to display the extraction results can vary based on the complexity of the Python
logic that you have created.

Important:  un documento di formazione può passare nonostante un errore segnalato dal modello
di convalida. A volte vogliamo che un modello di convalida segnali un errore, in modo che non passi
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documenti specifici in una fase successiva della produzione, ma li inserisca nella coda di convalida
manuale.

Close the window to return to the Designer.

Important:  se carichi 30 documenti e tutti i documenti sono classificati in un unico gruppo, puoi
visualizzare un solo documento per ogni layout univoco.

Export data to a CSV file

You can export the extracted data to a CSV file for ease of review. When you click Export to CSV, the
current document is downloaded to your device. To download other documents you must navigate to them
using the < and > buttons.
The data in the downloaded CSV file is displayed exactly how it will appear when IQ Bot downloads data
from a successfully processed document from a learning instance in production mode.

Review the learning instance details
Esamina i vari dettagli di un'istanza di apprendimento, ad esempio i gruppi associati, lo stato dell'ambiente,
i risultati della gestione temporanea e di produzione, il numero totale di documenti testati, la data di
modifica e così via.
Nella pagina Le mie istanze di apprendimento, seleziona un'istanza di apprendimento e utilizza le
seguenti schede per esaminare i dettagli:
• Gruppi documento: contiene un elenco dei gruppi di classificazione del documento per l'istanza di

apprendimento.
Quando si crea un'istanza di apprendimento e si caricano documenti per la formazione, questi vengono
automaticamente classificati nello stesso gruppo di documenti in base al loro contenuto e classificati di
conseguenza. Sono definiti gruppi di classificazione. Un bot ha più probabilità di estrarre correttamente
del testo tra i documenti in un gruppo con contenuto simile.

• Riepilogo: contiene vari dettagli sull'istanza di apprendimento, ad esempio i risultati della gestione
temporanea e di produzione, l'ambiente corrente in cui si trova l'istanza di apprendimento selezionata, il
numero totale di gruppi e bots associati e così via.

Note:  The system does not automatically refresh (auto-refresh) the My learning instances unless the
user loads a screen or clicks the Refresh button, thereby manually refreshing data on a page. Questa
funzione consente di ridurre il tempo di risposta per il caricamento di nuovi dati o per l'esecuzione di
qualsiasi operazione in IQ Bot.

Related concepts
Revisione del dashboard on page 2533
Il dashboard riassume il report sulle prestazioni e fornisce informazioni sull'elaborazione dei documenti in
formato grafico.

Eliminazione della mappatura in Designer
Elimina la mappatura delle etichette e dei valori dei campi, selezionando l'icona di eliminazione X accanto
all'etichetta o al valore mappati.
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I seguenti casi d'uso illustrano le opzioni di eliminazione della mappatura delle etichette e dei valori del
campo in Designer.

Eliminare un'etichetta del campo e il relativo
valore mappato:

Seleziona un'etichetta di campo nel pannello
centrale e fai clic sull'icona di eliminazione X della
casella di delimitazione nella vista del documento
per eliminare sia la mappatura dell'etichetta sia la
mappatura del valore. Anche l'etichetta e il valore
nel pannello centrale vengono eliminati. Il segno
di spunta della mappatura nei pannelli sinistro e
centrale passa da verde a grigio per indicare una
mappatura incompleta.

Eliminare un valore del campo: Per eliminare il valore mappato, seleziona il valore
del campo e fai clic sull'icona di eliminazione X della
casella mappata nella vista del documento. Anche
il valore nel pannello centrale viene eliminato. Il
segno di spunta nei pannelli sinistro e centrale
passa da verde a grigio per indicare una mappatura
incompleta.

Eliminare i campi con valore mappato
automaticamente:

L'icona di eliminazione X della casella mappata
nella vista del documento non è visibile fino a
quando l'utente non la ridimensiona o ne esegue
manualmente la mappatura.
Per un campo modulo, quando un utente elimina
una casella ridimensionata o mappata manualmente
intorno al valore del campo, IQ Bot ripopola il valore
mappato automaticamente originale.
Questo comportamento non si applica a un campo
di tabella/sezione, in quanto l'utente ha l'opzione di
mappare un nome, ma non un valore del campo e
viceversa.

Eliminare un'etichetta/un valore del
campo con o senza valore mappato
automaticamente:

Seleziona un'etichetta/un valore del campo con
o senza valore mappato automaticamente. La
casella di delimitazione con l'etichetta del campo
viene visualizzata nel documento con l'icona di
eliminazione X che consente agli utenti di eliminare
l'etichetta.

Eliminare la mappatura dell'etichetta del
campo con modello di convalida:

Anche se un'etichetta del campo è stata eliminata,
il modello di convalida assegnato al campo resta
presente.

Opzione di eliminazione ("X") quando la
casella delimitata raggiunge il limite di
spazio:

Se la casella delimitata del valore dell'etichetta/
del campo nella vista del documento copre un'area
più grande, estendendola al bordo della vista del
documento e oltre, l'icona di eliminazione "X"
compare nell'angolo più vicino della casella.

Nota:  la casella del valore del campo nel pannello centrale è disabilitata e gli utenti non possono inserire
manualmente il testo.
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Modelli di convalida di Designer
IQ Bot Designer consente di convalidare un campo e una colonna di tabella rispetto a una serie di
parametri predefiniti, in modo da poter essere avvisati in caso di mancata corrispondenza durante il
processo di digitalizzazione dei dati.

Convalidare un campo o una tabella

Convalida un campo o una colonna di tabella in base ai seguenti parametri predefiniti delle opzioni di
convalida:
• Inizia con/Termina con
• Modello
• Elenchi
• Formule

IQ Bot classifica i documenti in gruppi in base a contenuto, struttura e layout simili, facilmente
identificabili. Anche i documenti di esempio per la formazione sono scelti in base a questi criteri. Quando
avvii Designer per formare la tua istanza di apprendimento, IQ Bot carica e visualizza un documento di
esempio da ciascun gruppo classificato nel riquadro dei documenti.

Tip:  In Designer imposta i parametri di convalida definendo qualsiasi campo o colonna di tabella durante
la formazione del documento.

Inizia con e Termina con
Mentre tutte le convalide possono essere impostate al momento della definizione del progetto, è possibile
impostare le convalide Inizia/Termina con e Modello durante la formazione.
Per convalidare se i dati in un campo iniziano o finiscono con un determinato valore, utilizza i campi con
opzione di convalida Inizia con e Termina con. Durante la definizione della progettazione di un campo o
di una colonna di tabella, puoi specificare se i dati fanno parte del campo selezionato.
• Iniziano con un determinato valore utilizzando il campo Inizia con
• Terminano con un determinato valore utilizzando il campo Termina con

Se il valore Inizia con è "IN" e il valore estratto è "1N7646464", la convalida non riesce. Se il valore
Termina con è 2017 e il valore della data estratto è 10-ago-2017, la convalida viene superata.

Modello
Un modello aiuta a definire un formato accettabile per i dati.
Puoi convalidare i dati nel campo o nella colonna di tabella in base a un modello specifico. Durante la
definizione del campo o della colonna in Visualizzazione Design, specifica un modello dei dati nel campo
selezionato.
Specify a pattern for date, number, or text fields based on the different available patterns. Reference the
tables below for common examples:
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Testo

Field Pattern Notes Descrizione

E-mail ^([a-z0-9_
\.-]+)@([\da-z
\.-]+)\.([a-z\.]
{2,6})$

This regular expression
validates emails like
john@ado.com.

The Email field
supports regular
expressions.

Numero di telefono ^(\(?\+?[0-9]*
\)?)?[0-9_\-
 \(\)]*$

This regular expression
validates phone
numbers like (+64) 38
3235393.

The Phone Number
field supports regular
expressions.

Website ^([a-zA-
Z0-9]+(\.[a-zA-
Z0-9]+)+.*)$

This regular expression
validates websites like
www.domain.com.

The Website field
supports regular
expressions.

Number string ^[0-9]{1,45}$ This regular expression
validates a string with
numbers 0 - 9 and limit
length to 45.

The Number string
field supports regular
expressions.

Alpha-numeric ^[A-Za-z0-9_@./
#&amp;+-]*$

This regular
expression validates
a string containing
alphanumeric values
like INV-001.

The Alpha-numeric
field supports regular
expressions.

Numero

Field Pattern Notes Descrizione

Number string ^[0-9]{1,45}$ This regular expression
validates a string with
numbers 0 - 9 and limit
length to 45.

The Number string
field supports regular
expressions.

Auto Correction for date and number fields

This is one of the built-in features of IQ Bot for date and number format types. It performs automatic
validation and correction based on the defined pattern , even when the date/number in the scanned
document is incorrect.

Note:  Auto correction is only supported for special patterns.

The following table illustrates the auto-correction of an incorrect date and numbers by IQ Bot.

Incorrect OCR
value

Pattern Auto-Correction Descrizione
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DATE 12 F3B 2 0 1 5
15 10-2015

dd mmm yyyy
gg-mm-aaaa

12 FEB 2015
15-10-2015

In the first
example, IQ Bot
auto corrects
incorrect OCR
"F3B" to "FEB".
In the second
example, IQ Bot
auto corrects
"15 10-2015"
to"15-10-2015".

NUMERO 123 4567
12.34,S67.12

9999999
99,99,999.00

1234567
1234567,12

In the first
example, the extra
space between
"3" and "4" is
deleted after
validation against
the pattern.
In the second
example, the
alphabet "S" is
corrected as "5".

Note:  English language numeric value with at least one digit to the left and two consecutive digits to the
right (for example, 1.23) gets auto corrected if there is a space found between the decimal and the digits.
For example, values 1 . 23 or 1. 23 or 1 .23 get auto corrected to 1.23.

To use this feature, add Pattern (in validation options) to the selected date and number format fields.

Special number patterns

A special pattern consists of a Prefix, a Number Pattern, and a Suffix. Use for each is explained as follows:
• Prefix: Any symbol or a text string that is appended before the Number Pattern.
• Suffix: Any symbol or a text string that is appended after the Number Pattern.
• Number Pattern: Number pattern has two parts:

• Integer-part:
They are represented by nines (9s).
The 9s in the integer part represents integer pattern and separators such as commas, spaces, and
so on.

• Fractional part
They are represented by zeros.
If you need two fractional number, then it will be represented by two zeros.
Specifying fractional part is optional.
Format of numbers defined for validating numeric data.
IQ Bot supports prefixes and suffixes to make processing and validation of data easier. Specifying
a suffix and prefix in the pattern and in the numeric fields is optional. Even if you do not specify
the suffix or prefix, IQ Bot auto corrects and includes the required currency symbols and units of
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measure for the numeric fields as prefix or suffix. If you specify the currency symbols and units of
measurements in the pattern and in the numeric data, IQ Bot deletes the currency symbol and unit
of measure from the data.

Note:  IQ Bot automatically recognizes these currency symbols: $, ¥, £, ₹, €, Rs, USD,
 EUR, CAD, AUD, GBP, and INR. We recommend specifying valid currency symbols in the data.

IQ Bot supports prefixes and suffixes to make processing and validation of data easier. Specifying a suffix
and prefix in the pattern and in the numeric fields is optional. Even if you do not specify the suffix or
prefix, IQ Bot auto corrects and includes the required currency symbols and units of measure for the
numeric fields as prefix or suffix. If you specify the currency symbols and units of measurements in the
pattern and in the numeric data, IQ Bot deletes the currency symbol and unit of measure from the data.

Note:  IQ Bot automatically recognizes these currency symbols: $, ¥, £, ₹, €, Rs, USD, EUR,
 CAD, AUD, GBP, and INR. We recommend specifying valid currency symbols in the data.

Examples of special number patterns

Modello Esempio

Supported patterns Supported format for numeric patterns:
• Decimal (India)
• Decimal (US, UK, Australia and others)
• Number (India)
• Number (US, UK, Australia and others)
• Normal Decimal
• Normal Number

9.999.999,00 2.597,23

9999999,00 7562597,23

9 999 999.00 2 597,23

9 999 999,00 7 562 597,23

9999999,00 2597,23

9999999,00 7562597,23

99,99,999.00 75,26,569.56

$ 9.999.999,00 $ 7.562.597,23

$9 999 999.00 $7 562 597.23

9 999 999,00 $ 2 597,23 $

€ 9999999,00 € 7562597,23

€9999999.00 €7562597.23

99,99,999.00 € 75,62,597.23€

EUR 9.999.999.00 EUR 7.562.597.23

EUR9 999 999.00 EUR7 562 597.23
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Modello Esempio

9999999.00 EUR 62597.23 EUR

9999999.00 62.986.51

9, 999, 999. 00 232, 510. 68

Special date patterns

Supported date separators include /(forward slash), –(dash), space, .(dot), and ,(comma).
• d - Numeric day of the month, from 1 through 31 (eg. 5, 15 etc.)
• dd - Numeric day of the month, from 01 through 31 (eg. 05, 15 etc.)
• m - Numeric month (eg. 1 for January)
• mm - Numeric month (eg. 01 for January)
• mmm - First 3 letters of the month (eg. NOV for November)
• mmmm - Full name of the month (eg. June)

Examples of special date patterns

Modello Esempio

mm-dd-yy 01-31-18

mmm-dd-yyyy Jan-31-2018

mmmm dd, yyyy 2018-01-31

Mmmm d, yyyy 2018-01-09

D M YY 9 5 15

D MM YY 9 11 15

D MMM YY 7 MAR 15

D MMMM YY 7 MARCH 15

M DD YYYY 5 05 2018

D/MM/YY 2018-05-05

M/D/YY 2015-09-05

DD / M / YYYY 05 / 9 / 2018

MMM / DD / YY MAR / 05 / 18

D-MMMM-YY 09-APRIL-18

M-D-YY 5-5-18

MM-D-YY 11-5-18

MMM-DD-YYYY NOV-13-2018

DD - M - YYYY 13 - 5 – 2019

MMMM - DD - YY OCTOBER - 05 – 18
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Modello Esempio

D.MMMM.YYYY 05.APRIL.2018

MMMM.DD.YYYY APRIL.05.2018

D . M . YY 5 . 5 . 18

D . MM . YY 5 . 05 . 18

DD . MMM . YY 05 . JUL . 18

M . DD . YYYY 5 . 11 . 2018

MMMM . DD . YY MAY . 13 . 13

YYYY-MM-DD 2018-01-27

YYYY/MM/DD 2017/07/27

Elenchi
While defining a field or table column in the Design view, you can specify a list as part of validation option
for a selected field or table column. The extracted value of the field is validated against this predefined list
during Preview and Test Run.
You can only specify list validation when format of field or table column is "Text". If the lookup returns
multiple values for a word, the value is not auto corrected and the validation fails.
To specify list validation, do the following:
1. Select the validation type as List from the Validate drop-down menu.
2. Type a predefined list and click Define to save.

Each value in the list should be in a separate line.
If the extracted value does not match any value in the predefined list, the field is considered to have
failed validation.

Formule
Specify a formula as part of validation options for a selected field or table column. Use basic arithmetic,
comparative, logical, and functional operations.

Tip:  We recommended using functional operators instead of mathematical operators when validating
fields and tables for better accuracy.

When formulating an expression remember the following:
• All function names must be in capital letters.
• All formulas must result in either a true or false validation.
• Field and column names are case sensitive when used within formulas. If field is defined as Qty in

design, using qty or QTY in formula results in an invalid formula.
• For variable declaration or manipulation, ensure not to use certain keywords that are reserved for

formulating an expression, including SUM, SUB, DIV, MUL, COLSUM, IF.
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Mathematical Operators

Operations Descrizione Syntax

+ Addition Field/Column_Name1 + Field/
Column_Name2

- Subtraction Field/Column_Name1 - Field/
Column_Name2

* Multiplication Field/Column_Name1 * Field/
Column_Name2

/ Divisione Field/Column_Name1 / Field/
Column_Name2

Comparative Operators

Operations Descrizione Syntax

== Equal To [Current Field/Column Name]
== [expression comprised of
one or more field/column name
or fixed numeric values]
For example, AMOUNT ==
MUL(QUANTITY, UNIT_PRICE)

>= Greater than or Equal To [Current Field/Column Name]
>= [expression comprised of
one or more field/column name
or fixed numeric values]
For example,
TOTAL_BILL_AMOUNT >=
AMOUNT_PAID

<= Less than or Equal To [Current Field/Column Name]
<= [expression comprised of
one or more field/column name
or fixed numeric values]
For example, AMOUNT_PAID
<= TOTAL_BILL_AMOUNT

> Maggiore di [Current Field/Column Name]
> [expression comprised of one
or more field/column name or
fixed numeric values]
For example, BILL_AMOUNT >
0
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Operations Descrizione Syntax

< Minore di [Current Field/Column Name]
> [expression comprised of one
or more field/column name or
fixed numeric values]
For example,
DISCOUNT_PERCENTAGE <
100

!= Not Equal To [Current Field/Column Name] !
= [expression comprised of one
or more field/column name or
fixed numeric values]
For example, DEBIT_AMOUNT !
= 0

Logical Operators

Operations Descrizione Syntax

&& And: Field/Column is valid if all
conditions are true

<Current Field/Column Name>
<operator 1> <expression
1> && <Current Field/
Column Name> <operator 2>
<expression 2>
For example,
DISCOUNT_PERCENTAGE >=
0 && DISCOUNT_PERCENTAGE
<=100

|| Or: Field/Column is valid if any
one of the given conditions is
true

<Current Field/Column Name>
<operator 1> <expression
1> || <Current Field/Column
Name> <operator 2>
<expression 2>
For example,
DISCOUNT_PERCENTAGE >= 0
|| DISCOUNT_PERCENTAGE ==
'Net'

! Not: Converts a true expression
to false and also the other way
round

!<expression>
For example, !(AGE < 18) ==>
valid when AGE is not less than
18
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Functional Operators

Operations Descrizione Syntax

SOMMA Summation: gives result of
addition of one or more field/
column/fixed-number values

SUM(n1,n2,....,nN)
For example, SUM(SUB_TOTAL,
SERVICE_TAX,
EDUCATION_CESS) ==>
equivalent to SUB_TOTAL
plus SERVICE_TAX plus
EDUCATION_CESS

SUB Subtraction: gives result of
subtraction of one or more
field/column/fixed-number
values from the first specified
value

SUB(n1,n2,....,nN)
For example, SUB(SUB_TOTAL,
TOTAL_DISCOUNT,
ADJUSTMENTS) ==>
equivalent to SUB_TOTAL
minus TOTAL_DISCOUNT minus
ADJUSTMENTS

MUL Multiplication: gives result of
multiplication of one or more
field/column/fixed-number
values

MUL(n1,n2,....,nN)
For example,
MUL(QTY_IN_BOX,
UNIT_PRICE, SHIPPED_BOXES)
==> equivalent to
QTY_IN_BOX multiply-with
UNIT_PRICE multiply-with
SHIPPED_BOXES

DIV Division: gives result of
division of one or more field/
column/fixed-number values
from the first specified value

DIV(n1,n2,....,nN)
For example, DIV(AMOUNT,
SHIPPED_BOXES, UNIT_PRICE)
==> equivalent to AMOUNT
divide-by SHIPPED_BOXES
divide-by UNIT_PRICE
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Operations Descrizione Syntax

COLSUM Sum of a given Column
in a table: gives result after
evaluating given expression for
each row of specified table and
adding them all together

COLSUM("<table-name>",
"<expression to evaluate for
each row of specified table-
name>")
For example, FINAL_TOTAL
== COLSUM("LINE_ITEMS",
"MUL(QTY, UNIT_PRICE)")
Say there are 3 rows for
table LINE_ITEMS, then
FINAL_TOTAL should be equal
to MUL(QTY1, UNIT_PRICE1)
+ MUL(QTY2, UNIT_PRICE2) +
MUL(QTY3, UNIT_PRICE3)
where, QTY1 is QTY value in
row 1, similarly UNIT_PRICE1
is UNIT_PRICE value in row
2, and so on for other rows as
well.

Aggiunta di logica personalizzata per migliorare l'estrazione automatica in
produzione
Puoi immettere la logica in IQ Bot Designer per migliorare l'estrazione e la convalida del testo e ridurre il
numero di documenti che accedono a Validator e che richiedono la post-elaborazione RPA.

Panoramica

Per Automation 360 IQ Bot Cloud, è disponibile un elenco identificato di librerie e pacchetti Python che
possono essere utilizzati in sicurezza per la funzionalità Custom Logic (Logica personalizzata). Utilizza solo
questi pacchetti per garantire la sicurezza dell'infrastruttura cloud, dei file system, dei database e delle
risorse di rete: List of Pandas Libraries which are supported and not supported on Automation 360 IQ Bot (A-
People login required)

Tieni presente quanto segue:
• La logica personalizzata viene eseguita in ordine sequenziale in tutte le tabelle e i campi.
• L'applicazione di una logica personalizzata potrebbe aumentare il tempo di estrazione per documento.
• Le regole di convalida di Automation 360 IQ Bot si applicano ai valori estratti elaborati dallo script

personalizzato.
• Lo script personalizzato funziona solo sui dati estratti e non influenza la qualità dell’estrazione OCR.
• Always test your Python script before processing documents in a learning instance in production

La funzionalità della logica personalizzata consente di eliminare i valori estratti prima della fase di
convalida, ma non sostituisce l'intero processo di post-elaborazione attualmente eseguito utilizzando il
TaskBot. Oltre ad aggiungere script inline, gli utenti possono utilizzare gli script Python in una posizione
centrale, importarli come moduli e chiamare le funzioni per ridurre la quantità di codice Python utilizzata a
livello di campo o di tabella.
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Restriction:  Se il numero di caratteri nel codice Python insieme ad altre informazioni supera 32000
e questo codice viene inviato al back-end come argomento di runtime di Windows per il processo,
l'esecuzione non riesce e non viene visualizzato alcun messaggio di errore.

Risorse

Per ulteriori informazioni, fai riferimento al corso Utilizzo della logica personalizzata in IQ Bot in Automation
Anywhere University: RPA Training and Certification (A-People login required).

Passo successivo
Utilizzando gli script, in IQ Bot Designer aggiungi i campi Modulo e i campi Tabella.

Campi modulo
Puoi aggiungere script in Designer per i campi del modulo.
La Convalida dell'elenco tramite file esterno può essere implementata come parte della logica personalizzata
del campo utilizzando script python direttamente in Designer.
1. Nel pannello sinistro di IQ Bot Designer, evidenzia un campo del modulo di cui desideri migliorare

ulteriormente l'estrazione/la convalida.
2. In the middle panel, scroll down to Field options > Logic.
3. In quella sezione Logica, passa da schermo intero a schermo piccolo e viceversa per una

maggiore facilità d'uso.
4. Aggiungi il codice per modificare il valore del testo estratto di IQ Bot. Vedi l'esempio seguente:

# variable that stores the value: field_value

# import the Python regular expression library, re
import re

# call the regular expression library's method, findall, to extract the
 date value only
field_value = re.findall(r'\d{2}-\d{2}-\d{4}', field_value)[0]

5. Seleziona Esecuzione di test per testare lo script e visualizzare i risultati prima e dopo.

value_before: 2018/11/09 B210
value_after:  2018/11/09

Campi tabella
Puoi aggiungere script in Designer per i campi delle tabelle.
1. In IQ Bot Designer, nel pannello di sinistra, evidenzia Impostazioni tabella/sezione per la tabella

la cui estrazione/convalida intendi migliorare ulteriormente.
2. Nel pannello centrale, scorri verso il basso fino a Logica.
3. Nella sezione Logica, passa da schermo intero a schermo piccolo e viceversa per una maggiore

facilità d'uso.
4. Add code to modify the extracted table values, which are stored as a Python dictionary in a user

variable called table_values. Vedi l'esempio qui sotto.
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Ogni riga presenta un Guid (identificatore univoco globale), che consente a IQ Bot di tenere
automaticamente traccia delle righe che vengono aggiunte ed eliminate. Se aggiungi una riga, non è
necessario immettere un GUID. IQ Bot gestirà questo automaticamente.

# variable that stores the value: table_values

# convert from dictionary to dataframe
df = pd.DataFrame.from_dict(table_values)

# print dataframe before update
print(df)

# Item_Description: drop rows with a missing value
df = df[(df["Item_Description"] != "")]

# Quantity: extract first part of the string, the numeric part only
df['Quantity'] = df['Quantity'].str.split(' ', 1).str[0].str.strip()

# print dataframe after update
print(df)

# convert back from dataframe to dict to override what IQ Bot stores
table_values = df.to_dict()

5. Seleziona Esecuzione di test per testare lo script e visualizzare i risultati prima e dopo.

      Item_Description                                  Guid        
 product_id     Quantity Item_Total
0         wafer, NO172  43ea78f4-7b9b-413a-83ce-89d671478d6c  2
 COMS5A-18090220     4.00 PCS   5,840.00
1  Visual Iaspection +  cc774f5f-2507-4a15-8e45-7b2abf84fabe             
            1.00 EA      65.00
2                       6bddfed1-2359-4305-a0ac-a1769c113bfb   5% VAT :
 Total -  4.00PCS GR:   5,905.00
3                       2dc642a7-8e6e-4bc6-9672-85afff8c21db           
 Total -         KGD:       0.00

      Item_Description                                  Guid        
 product_id     Quantity Item_Total
0         wafer, NO172  43ea78f4-7b9b-413a-83ce-89d671478d6c  2
 COMS5A-18090220     4.00       5,840.00
1  Visual Iaspection +  cc774f5f-2507-4a15-8e45-7b2abf84fabe             
           1.00          65.00

6. Se selezioni Guarda i risultati dell'estrazione o salvi il bot, lo script viene salvato.

Casi d'uso ed esempi
I seguenti sono alcuni dei casi d'uso supportati dalla funzionalità di script di Designer.
Per gli esempi di script utente e dei casi d'uso, vedi:IQ Bot custom logic use cases and examples

Di seguito sono riportati alcuni casi d'uso:
• Esecuzione di una query su un valore estratto rispetto a un database in un sistema ERP per convalidare

i valori.
• Estrazione di "0123456" da "PO 0123456
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• Rimozione delle righe della tabella contenenti "Page x of y".
• Estrai la valuta da un campo della tabella (ad esempio: Totale articoli) e salvalo in un campo della

tabella vuoto.
• Estrai il codice prodotto da un campo della tabella (ad esempio: Descrizione articolo).
• Estrazione del codice postale da un indirizzo.
• Esecuzione di una query su un servizio REST (ad esempio: aggiunta di NLP, recupero dei dati da un

sistema esterno e così via).
• Restituzione di un valore booleano sì/no per indicare se esiste una scrittura manuale per un campo.

Pacchetti Python preinstallati
Per aumentare la facilità d'uso e la coerenza del comportamento tra i server, IQ Bot installa
automaticamente Python v3.11.0 e alcuni dei pacchetti Python più diffusi riportati di seguito.

Table 7: Pacchetti Python preinstallati

Pacchetto principale Versione URL

difflib Python integrato con lo
strumento di installazione

https://docs.python.org/3/library/
text.html

io Python integrato con lo
strumento di installazione

https://docs.python.org/3/library/
io.html

re Python integrato con lo
strumento di installazione

https://docs.python.org/3/library/
text.html

sqlite3 Python integrato con lo
strumento di installazione

https://docs.python.org/2/library/
sqlite3.html

stringa Python integrato con lo
strumento di installazione

https://docs.python.org/3/library/
text.html

stringprep Python integrato con lo
strumento di installazione

https://docs.python.org/3/library/
text.html

sys Python integrato con lo
strumento di installazione

https://docs.python.org/3/library/
sys.html

textwrap Python integrato con lo
strumento di installazione

https://docs.python.org/3/library/
text.html

unicodedata Python integrato con lo
strumento di installazione

https://docs.python.org/3/library/
text.html

Data e ora 4,3 https://pypi.org/project/DateTime/

pandas 0.24.2 https://pypi.org/project/pandas/

inflection 0.3.1 https://github.com/jpvanhal/
inflection

dateutils 0.6.6 https://pypi.org/project/dateutils/

tabulate 0.8.3 https://pypi.org/project/tabulate/

numby 1.16.4 https://pypi.org/project/numpy/

json 2.0.9 https://docs.python.org/3/library/
json.html
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Pacchetto principale Versione URL

requests 2.22.0 https://github.com/kennethreitz/
requests

psycopg2 2.8.3 https://pypi.org/project/psycopg2/

pymongo 3.8.0 https://pypi.org/project/pymongo/

piodbc 4.0.26 https://github.com/mkleehammer/
pyodbc

opencv-python 4.1.0.25 https://pypi.org/project/opencv-
python/

Pillow 6.0.0 https://github.com/python-pillow/
Pillow

cx_Oracle

Note:  As of Build 16685, this
module is replaced by oracledb.
See Upgrading from cx_Oracle
8.3 to python-oracledb

7.1.3 https://github.com/oracle/python-
cx_Oracle

oracledb 1.2.1 https://github.com/oracle/python-
oracledb

Python Arabic Reshaper 2.0.15 https://github.com/mpcabd/python-
arabic-reshaper

Pacchetti aggiuntivi di Python
Per consentire una maggiore capacità di elaborazione, puoi aggiungere più librerie Python da utilizzare in
IQ Bot.
1. Apri il prompt dei comandi.
2. Nel prompt dei comandi, modifica la directory nel dizionario Python di IQ Bot. Ad esempio: C:

\Python354-x86-IQBot.
3. Installa il pacchetto Python in quella posizione. For example: pip install PyArabic.
4. In IQ Bot Designer > Logic, you can import and use that Python package.
5. Se il passaggio 4 non funziona, arresta/disinstalla, quindi installa/avvia i servizi.

Estrazione dei dati utilizzando il riconoscimento dei caratteri a inchiostro
magnetizzato
Puoi utilizzare la funzione OCR di riconoscimento dei caratteri a inchiostro magnetizzato (Magnetic Ink
Character Recognition, MICR) con il supporto di ABBYY FineReader Engine versione 12.2 per estrarre i dati
MICR dai controlli finanziari.

Note:  Documents in Non-Latin based languages cannot be processed if MICR is enabled on ABBYY
FineReader Engine OCR version 12.3 and 12.4.

• Assicurati che ABBYY FineReader Engine sia installato nella cartella dei plug-in: \OCR Plugins\ABBYY
 SDK\12\. . ..
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• Dalla cartella C:\Program Files (x86)\Automation Anywhere IQ Bot
 (version)\Configurations, apri il file Settings.txt, modifica OCREngine=Tesseract4 in
OCREngine=Abbyy e salva il file.

Note:  Non è necessario riavviare il sistema.

La funzione MICR è supportata con ABBYY FineReader Engine versione 12.2 .
1. Imposta ABBYY FineReader Engine nel file settings.txt come motore OCR principale.
2. Accedi al file IQ Bot\Configurations\AbbyyImagePreProcessingSettings.json.
3. Aggiorna i seguenti parametri:

• TextTypes = 129
• DetectTextTypesIndependently =true

La funzione MICR sarà attivata nel sistema.

• Crea un'istanza di apprendimento e aggiungi i campi modulo per estrarre i dati MICR dai controlli
finanziari come MICR e Paga a.

• Esegui la scansione e carica un controllo in IQ Bot per la formazione. In produzione, carica i controlli
finanziari per l'estrazione accurata dei dati MICR.

• In Designer, mappa i dati MICR nel controllo finanziario per l'estrazione.
• In produzione, carica i controlli finanziari per l'estrazione accurata dei dati MICR.

Impostazione di un'istanza di apprendimento su Produzione
Dopo aver formato un'istanza di apprendimento su Gestione temporanea per estrarre dati da documenti
con elevata precisione, è possibile spostarla in Produzione. Ciò consente di distribuire l'istanza di
apprendimento sui documenti di produzione per l'estrazione dei dati in tempo reale.
Utilizza il pulsante Imposta istanza in produzione per spostare un'istanza di apprendimento in
Produzione. Quando sposti un'istanza di apprendimento nell'ambiente di produzione viene visualizzato un
messaggio di conferma. Per confermare, fai clic su Sì, invia a produzione. Le istanze di apprendimento
nell'ambiente di produzione sono identificate dall'etichetta Produzione accanto al nome.

Tip:  È inoltre possibile utilizzare la pagina Le mie istanze di apprendimento per spostare un'istanza di
apprendimento in Produzione.

Note:  During the production process, you must not move the learning instances or bots from Staging to
Production or vice-versa.

Manage learning instances
A learning instance is an IQ Bot structure that describes the data in a single document type, for example
an invoice. It contains information such as the language used in the document and the fields to extract.
A learning instance can be either in staging or production mode. These modes determine whether the
learning instance is a draft or live version.

Gestione temporanea In the staging mode, you can create and edit
learning instances, upload sample documents,
and train bots to extract data from the sample
documents you uploaded. You can test and improve
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the accuracy of a learning instance and its bots
before deploying it to production mode.

Note:  Because the data generated by learning
instances in the staging mode is based on sample
documents, it is kept separate from data pertaining
to learning instances in production mode. For
example, sample documents are not counted
against your organization's purchased pages.
Per ulteriori informazioni, consulta Revisione del
dashboard on page 2533.

Produzione In the production mode, a learning instance can
automatically process real business documents,
extract data, and send documents requiring manual
validation to the validation queue.

To find out which mode a learning instance is in, navigate to the LEARNING INSTANCES tab, where the
My learning instances page displays the learning instances in the environment. Each learning instance
has a toggle in the Actions column, which indicates whether it is in staging (toggle to the left and is
colored gray) or production (toggle to the right and colored orange).

Based on the mode that a learning instance is in, different user types contribute to IQ Bot. For example, in
the staging mode, the Data engineer creates learning instances and the Bot builder builds supporting RPA
bots, and in the production mode, the Validator manually corrects the fields in the documents that IQ Bot
could not process. To learn more about how each user contributes to IQ Bot, see IQ Bot process overview.

Note:  The following are the file size restrictions in each stage:
• In staging, you can upload a maximum of 150 documents of 10 MB file size per learning instance.
• In production, you can upload a maximum of 50 MB file size per document. However, the maximum

number of documents allowed per learning instance depends on the license.
• There are no limitations on the number of pages per document in a pdfbox OCR.
• You can upload 60 pages per document in an image-based OCR.
• With the Tesseract4 OCR, there is a known limitation that restricts the number of pages per document

to fewer than 60 pages.
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The learning instance lifecycle

The staging and production modes are independent from the IQ Bot environment when it comes to the
traditional DevOps workflow of separate development, testing, and production environments. A learning
instance can be in either mode in any of the environments in the development life cycle.

Note:  When you transfer a learning instance, it remains in the mode in which it was exported. For
example, if you export a learning instance in staging mode from the development environment and import
it to the testing environment, the learning instance will still be in staging mode and it will not perform
document processing automatically.

The following image shows the typical lifecycle of a learning instance:

You can transfer learning instances across environments by using the Migration Utility. This helps you to
avoid having to recreate similar learning instances and better manage the lifecycle of the associated bots.
Per ulteriori informazioni, consulta Migrazione delle istanze di apprendimento on page 1347.

Rotazione della chiave esterna
La Control Room supporta l'uso di CyberArk per memorizzare le chiavi per crittografare e decrittografare i
dati IQ Bot. A user with the AAE_IQ Bot Admin role can change the object name in IQ Bot to start the
key rotation process.
• Il sito IQ Bot deve essere stato collegato a CyberArk durante l'installazione. Consulta Installazione di IQ

Bot in modalità Personalizzazione on page 1079.
• Aggiornare la password nel vault CyberArk per generare la nuova chiave. Prendi nota del nome della

nuova chiave perché dovrai fornirlo in IQ Bot.

1. Vai a Amministrazione > Rotazione della chiave.
La maggior parte dei campi nella pagina Rotazione della chiave vengono riempiti automaticamente
con i dettagli di connessione che hai fornito durante l'installazione.

2. Nel campo Nome oggetto fornisci il nome della nuova chiave di CyberArk.
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3. Fai clic su Ruota chiave.
IQ Bot recupera la nuova chiave dal vault CyberArk e crittografa i dati con questa nuova chiave.
Quando il processo di crittografia è completato, appare un messaggio di operazione riuscita.
Se il processo di crittografia non viene eseguito correttamente, usa il sincronizzatore di rotazione della
chiave per risolvere l'errore.

Use the IQ Bot Validator
Use the Validator to manually validate documents from which IQ Bot could not extract data.
When IQ Bot processes documents in a learning instance that is in production mode and encounters one of
the following scenarios, IQ Bot sends that document to the Validation queue.
• Data is not readable, such as blurry text or dark background.
• Data is missing from a required field.
• Document failed an automated processing rule.
• Fields did not meet the set optical character recognition (OCR) confidence threshold.

Note:  Per ulteriori informazioni su come è possibile utilizzare l'attendibilità OCR a livello di campo per
migliorare la qualità dell'output STP, vedi Miglioramento della qualità di output utilizzando l'attendibilità OCR
on page 2503.

A user with the AAE_IQ Bot Validator role opens the Validator window, where they correct the flagged
fields.
Once all the fields in the document are corrected, IQ Bot finishes processing the document and exports the
data to a .CSV file in the Learning Instance success folder.

Note:  If a document required manual validation, it is excluded from the straight-through processing (STP)
metric. For more information on the dashboard metrics, see Revisione del dashboard on page 2533.

As you work on a document in the Validator queue, if you leave the Validator queue or log out of IQ Bot,
the lock on the document is released, allowing other users to access or validate the document.

Validator interface overview

The Validator interface opens with the first document from the validation queue. The data requiring
validation distinguished with red text or outlined in red boxes.

Note:  An empty page with a notification message appears in the following scenarios:
• Se non sono disponibili file nella coda di convalida.
• Se un file non esiste nella coda di convalida.
• Se un altro utente sta lavorando con il file rimanente nella coda di convalida.
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1. Provide the values for fields IQ Bot could
not extract

Click the empty text field, then select the blue-
bounded box in the document that contains the
data to extract. After you select a box, the data is
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highlighted in yellow and a green outline appears,
which you can resize or reposition to include all the
data that you want to extract.

2. Fields awaiting validation are outlined in
red

In the example above, the table fields Item total
and Quantity require manual entry.

3. Add or delete a row To insert or delete a row, hover over the ellipses to
show the icons for adding or deleting table rows.

4. Contrassegnare un documento come non
valido

Removes the document from the validation queue
and saves a copy of the document to the Invalid
folder. Click here to mark a document as invalid,
then select from the following reasons:
• Campi mancanti
• Tabelle mancanti
• Valori errati

5. Salva il documento corrente After you have validated all the fields, click here so
IQ Bot can finish processing this document.

6. Skip to next file Skip a file without correcting the errors in the
current document.

Linked tables in the Validator

Some pages in a document might contain more than one table. When there is a relationship between the
tables, such as in the example page below, where a parent table contains patient information and child
tables contain additional information related to that patient, these are called linked tables.
In the example page below, the red box outlines the parent table and each of the blue boxes outline a
child table.

© 2023 Automation Anywhere. All rights reserved.     2532



    Automation Anywhere - Digitalizzazione

To successfully validate a page with linked tables, add the fields from the child tables to same table-
repeated section as the parent table.
If shared fields between the linked tables do not match values, the Validator does not let you complete
validation and save your changes. Questa funzionalità consente di evitare errori di convalida manuali che
possono verificarsi in caso di mancata corrispondenza dei valori dei campi tra le tabelle padre e figlio.
Validator visualizza un messaggio di errore e impedisce il salvataggio.

Note:  In Validator, if you mark an already corrupted document as invalid then that document is lost in
the IQ Bot system. Instead, you will see a placeholder image and you must refresh the page to go to the
next document. This applies to single page as well as multi-page documents.When the entire multi-page
document is deleted or corrupted, you will not be able to navigate between the pages. If you click the next
page button, then the Loading document screen is displayed.

Using the Validator

Open the Validator user interface from the LEARNING INSTANCES tab. If a learning instance contains
documents that require validation, there will be a document icon with a red exclamation mark in the
Actions column. Click the document icon to launch the Validator.

Note:  Solo gli utenti con un ruolo Validator assegnato possono visualizzare la pagina Convalida. Per
ulteriori informazioni, consulta IQ Bot user personas and roles on page 2476.

Revisione del dashboard
Il dashboard riassume il report sulle prestazioni e fornisce informazioni sull'elaborazione dei documenti in
formato grafico.
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Il rapporto viene visualizzato quando si accede a IQ Bot. Le informazioni visualizzate comprendono:
classificazione dei documenti, elaborazione interamente automatizzata (Straight-Through Processing,
STP), precisione e convalida umana per fornire informazioni sulle azioni per una specifica istanza di
apprendimento, in modo da concentrarti sulle aree che richiedono attenzione.
Il dashboard di IQ Bot è diviso in due aree principali:
• I miei totali
• Le mie istanze di apprendimento

Area I miei totali

I miei totali è un'area di visualizzazione del Dashboard che fornisce una rapida visualizzazione generale
dello stato di tutte le istanze di apprendimento nell'ambiente di produzione.
Visualizza le seguenti informazioni nell'area I miei totali:
• Documenti elaborati: numero totale di file elaborati nell'ambiente di produzione.

Note:  Se un file è danneggiato e non può essere aperto, non è incluso in questo conteggio.

• Pagine acquistate: numero di pagine acquistate nel periodo di licenza corrente.
Per esempio, se 4.000 pagine sono state acquistate prima del 31 dicembre 2020 e altre 20.000 pagine
sono state acquistate tra il 1° gennaio 2021 e il 28 febbraio 2021, la metrica delle pagine acquistate
mostrerà un conteggio di 20.000 pagine, non 24.000. Questo perché 4.000 delle pagine sono state
acquistate prima del periodo di validità della licenza.

Note:  This metric is visible only to users with the AAE_IQ Bot Admin role or a custom role with the
View administration permission.

• Pagine caricate: numero di pagine caricate su un'istanza di apprendimento nell'ambiente di
produzione nel periodo di licenza corrente. When the license is renewed, the value reverts to zero.
Questa metrica è diversa da quella dei documenti elaborati perché un documento può contenere più
pagine. Inoltre, il conteggio delle metriche include le pagine che sono state caricate ma non hanno
completato l'elaborazione.

Note:  In releases prior to Automation 360 v.23, this metric reflected the number of pages uploaded to
learning instances in the production environment from the time of IQ Bot installation.

• Elaborazione interamente automatizzata (STP): percentuale del numero totale di file caricati che
sono stati elaborati correttamente senza intervento manuale.

• Precisione: precisione del campo, vale a dire un valore percentuale dei campi identificati
accuratamente. Sono inclusi i campi i cui livelli di attendibilità del riconoscimento ottico del carattere
(Optical Character Recognition, OCR) superano la soglia di attendibilità impostata.

Area Le mie istanze di apprendimento

Puoi visualizzare informazioni dettagliate sulle istanze di apprendimento create che si trovano negli
ambienti di gestione temporanea e di produzione.
Visualizza informazioni sulle istanze di apprendimento nell'ambiente di gestione temporanea:
• Nome dell'istanza di apprendimento
• Dominio o tipo di documenti. Ad esempio fatture e ricevute.
• Numero di documenti nell'istanza di apprendimento
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• Una rappresentazione grafica dei documenti formati che mostra i dettagli in percentuale

Visualizza informazioni sulle istanze di apprendimento nell'ambiente di produzione:
• Numero di file elaborati
• Elaborazione interamente automatizzata (STP) dei file che sono stati elaborati correttamente senza

intervento manuale
• Precisione del campo in percentuale

Important:  Talvolta, il numero di documenti nel dashboard e nella pagina di riepilogo dell'istanza di
apprendimento non corrisponde al numero di documenti inviati per l'elaborazione. Questo può verificarsi
quando i documenti vengono classificati in gruppi che non sono in produzione. I documenti di questa
categoria non vengono elaborati (per programmazione), causando una mancata corrispondenza tra il
numero di documenti elaborati e il numero di documenti totali. In tal caso, se questi gruppi vengono
spostati in produzione, i numeri totali dei documenti corrisponderanno.

Pagina di report sulle prestazioni
La pagina di report sulle prestazioni mostra i dettagli di un'istanza di apprendimento nell'ambiente di
produzione.
Navigate to My learning instances > Production button to view the Performance report page
showing details of all learning instances in the production environment.

Note:  La pagina Report sulle prestazioni non è disponibile per le istanze di formazione presenti
nell'ambiente di gestione temporanea.

Nell'angolo in alto a destra della pagina del report sulle prestazioni viene visualizzata la percentuale di
bot formati per l'istanza di apprendimento. Di seguito è riportato un esempio di come interpretare le
informazioni sulla percentuale.

Cathy ha caricato 10 documenti e ha creato tre bot per l'istanza di apprendimento:
• Bot1
• Bot2
• Bot3

Di questi, tre documenti fanno parte del Bot1, quattro documenti del Bot2 e tre documenti del Bot3.
Quando Cathy imposta Bot1 nell'ambiente di produzione, l'etichetta visualizza il 33% come percentuale di
bot formati per l'istanza di apprendimento, il che significa che 3 dei 10 (33%) documenti caricati (per Bot1)
sono stati formati.

Dettagli del report sulle prestazioni
Nell'area Le mie istanze di apprendimento, fai clic su qualsiasi informazione visualizzata per
visualizzare la pagina Report sulle prestazioni. Di seguito sono riportate le informazioni per ciascuna
sezione visualizzata del report sulle prestazioni.

Totali di istanza ed Elaborazione dei risultati

L'area Totali di istanza e Elaborazione dei risultati mostra le seguenti informazioni per un'istanza di
apprendimento:
• Numero di file caricati per l'istanza di apprendimento: è il numero totale di file caricati da elaborare.
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• Numero di file elaborati per l'istanza di apprendimento: è il numero di file elaborati da un bot.
• Numero di file elaborati correttamente per l'istanza di apprendimento: include i file elaborati con esito

positivo da un bot senza intervento umano.
• Numero di file inviati alla convalida per l'istanza di apprendimento: sono i file contrassegnati con uno o

più errori che necessitano dell'intervento umano per la revisione.
• Numero di file convalidati per l'istanza di apprendimento: è il numero di file rivisti da una utente, i cui

risultati sono stati salvati.
• Numero di file contrassegnati come non validi per l'istanza di apprendimento: è il numero di file rivisti

da una utente, i cui risultati sono contrassegnati come non validi.

Risultati della classificazione

L'area Classificazione fornisce una visualizzazione statistica della rappresentazione grafica del campo.

Risultati della precisione

L'area Precisione fornisce una rappresentazione grafica dei tipi di campo.

Convalida

L'area Convalida fornisce le seguenti informazioni:
• Una rappresentazione statistica delle correzioni apportate ai singoli campi durante il processo di

convalida di un documento.
• Una rappresentazione statistica del tempo medio impiegato per convalidare un gruppo.

Custom domains in IQ Bot
A domain contains information about the language of the documents and the data fields that the system
extracts from the documents. The IQ Bot environment includes seven domains; users with the AAE_IQ
Bot Admin role can also create and import custom domains to the Domains tab.
If your documents contain specialized fields, you can create a custom domain with these fields to make
learning instance creation quicker. Otherwise, the learning instance creator must manually define each
specialized field, every time they create a new learning instance.
For example, for documents from the pharmaceutical industry, you might add fields like prescription name,
dose, or delivery format to the custom domain. Likewise for financial industry documents, you might add
fields for margin, call price, or limit order.
La scheda Domini visualizza tutti i domini disponibili per l'uso nel sistema e le relative lingue associate.
Oltre ai domini già pronti offerti da IQ Bot, puoi anche creare un dominio personalizzato e importarlo in IQ
Bot.
Create a custom domain (A-people login required)

Quando crei un'istanza di apprendimento utilizzando un dominio personalizzato:
• Le lingue assegnate al dominio durante la creazione dello stesso vengono visualizzate ed è possibile

selezionarle dall'elenco a discesa Lingua principale dei documenti.
• I campi selezionati durante la creazione del dominio personalizzato vengono visualizzati nella sezione

Campi da estrarre della pagina Crea nuova istanza.
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È possibile importare o esportare un dominio utilizzando l'opzione Importa o Esporta nella scheda
Domini.

Nota:  I domini vengono creati e salvati nel sistema con l'estensione .dom.

Suggerimento:  risolvi eventuali problemi di classificazione con i documenti in lingua cinese:
Classification issue with Chinese Invoices (A-People login required)

Importazione di un dominio

Puoi importare un dominio per i seguenti scenari:
• Importazione di un nuovo dominio.
• Puoi importare un dominio esistente nel sistema corrente da un altro sistema.

Quando sei pronto per importare un dominio nel sistema:
1. Accedi al sistema in cui desideri importare il dominio.
2. Click Import new domain in the Domains tab and select the .dom domain file in your local

machine that you want to import.
Il messaggio di importazione del dominio riuscita viene visualizzato nella scheda Domini.
Il dominio importato viene visualizzato per la selezione nell'elenco a discesa Tipo di documento della
pagina Crea nuova istanza e viene visualizzato nell'elenco dei domini della pagina Domini.

Esportazione di un dominio

Quando si fa clic sull'opzione Esporta accanto a un dominio, questo viene esportato in una cartella di
output sull'unità locale. Il dominio esportato viene crittografato e creato con l'estensione .dom filename.
Puoi esportare un dominio esistente da un sistema IQ Bot per importarlo in un altro.
Per esportare un dominio dal sistema IQ Bot, procedi nel modo seguente: Nella pagina dell'elenco Domini,
fai clic sull'opzione Esporta accanto al dominio che si desidera esportare.
Viene visualizzato un messaggio di operazione riuscita per il dominio esportato.
Il file viene esportato in una cartella di output locale del computer con estensione .dom filename.

Nota:  I file di dominio vengono crittografati per motivi di sicurezza.

Limitazioni correnti alle operazioni di importazione ed esportazione del
dominio

Importante:  L'importazione o l'esportazione dei domini è indipendente dall'operazione di migrazione
nella funzionalità Utilità di migrazione.

When you migrate learning instances that were created using a custom domain from one system to
another, the field names and IDs must be the same in the target machine as well. Otherwise, even though
the learning instances are imported, the custom domain will not be imported and the associated field
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names and IDs for the custom domain will not work in the imported learning instance. Se esegui l'istanza
di apprendimento importata sui documenti, i documenti non verranno classificati.
Anche se importi il dominio personalizzato nel nuovo sistema, i nomi di campo e gli ID non
corrisponderanno, in quanto vengono generati automaticamente dal sistema. Pertanto, la classificazione
non verrà eseguita. Questa è la limitazione corrente della funzionalità Utilità di migrazione che utilizza un
dominio personalizzato.
Soluzione: First import the .dom file to the target machine, then migrate the learning instances. Sposta
tutte le istanze di apprendimento nell'ambiente di gestione temporanea e testale prima di spostare l'istanza
di apprendimento nell'ambiente di produzione.

Miglioramenti dei domini personalizzati

Importazione dei domini personalizzati in qualsiasi ordine
Quando esegui la migrazione delle istanze di apprendimento (create utilizzando un dominio personalizzato)
dal server di gestione temporanea nel server di produzione, la migrazione non riesce a meno che tu non
importi le diverse versioni del dominio personalizzato nello stesso ordine in cui erano state create.
Poiché la capacità di modificare un dominio personalizzato di aggiungere ulteriori campi e alias non era
disponibile, l'utente aveva dovuto creare un nuovo dominio e aggiungervi i campi e gli alias aggiuntivi.
Quindi, l'utente dovette assegnare quel nuovo dominio all'istanza di apprendimento. Pertanto, quando
l'utente desiderava utilizzare il nuovo dominio, doveva reimportare l'originale e il nuovo dominio nel server
di produzione nell'ordine in cui erano stati creati.
Importing custom domain to IQ Bot production (A-People login required)

Dalla versione Automation 360 Build 5322, questa restrizione non c'è più.
• Puoi modificare e aggiornare un dominio personalizzato esistente più volte e importarlo anche nel

server di produzione più volte.
• Puoi importare i domini personalizzati in qualsiasi ordine. Il sistema migra correttamente i campi

aggiornati (modulo o tabella) e gli alias dei campi (variazioni dei valori dei campi presenti nei documenti
di formazione, associati a un campo) nel server di produzione.

Importante:  Esegui tutte le modifiche o gli aggiornamenti a un dominio personalizzato nel server di
gestione temporanea prima di importarlo nel server di produzione per evitare errori.

IQ Bot esegue la classificazione dei documenti in base ai campi e agli alias definiti della versione del
dominio personalizzato utilizzata al momento della creazione dell'istanza di apprendimento.
La modifica dello stesso dominio personalizzato (con campi aggiuntivi) determina la modifica della versione
del dominio personalizzato. Per le nuove istanze di apprendimento create utilizzando la nuova versione del
dominio personalizzato, la classificazione viene eseguita anche nei campi aggiornati. I campi modificati
(siano essi campi di modulo o di tabella) vengono visualizzati nell'istanza di apprendimento con un doppio
asterisco accanto per facilitarne l'identificazione.

Using IQ Bot for standard forms
I moduli standard sono documenti di tipo a formato fisso che solitamente contengono un gran numero
di campi con una variazione minima o nulla nel layout complessivo e che possono includere sia contenuti
scritti a mano che contenuti digitali. IQ Bot consente di estrarre i dati dai moduli standard.

Alcuni esempi di moduli standard sono W-4 (Employee Withholding Certificate, certificato di ritenuta
dei dipendenti), modulo di dichiarazione dei redditi, atto di vendita o accordo di partnership. È possibile
estrarre dati da moduli standard personalizzando e creando un modello prima di impostarlo in IQ Bot. Il
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modello di apprendimento automatico è un file che può essere addestrato a riconoscere determinati tipi
di modelli. È possibile utilizzare un documento campione con un set di dati per addestrare un modello a
riconoscere i modelli.
In base al ruolo o all'autorizzazione associati definiti dall'amministratore Control Room, è possibile creare
un'istanza di apprendimento utilizzando questo modello per estrarre i dati dai moduli standard.

Note:  Users must have the Standard forms pages product license to upload documents for processing.
Per ulteriori informazioni, consulta Licenze Automation 360 on page 1010.

The following workflow describes the various stages and procedures for setting up data extraction from
standard forms:
1. Evaluate your use case for standard forms.

Evaluate your use case on page 2540
2. Review the type of standard forms extraction service that fits your requirement.

Rivedi il servizio di estrazione on page 2542
3. Review the service implementation prerequisites.

Rivedi i prerequisiti per l'implementazione on page 2543
4. Set up and configure an extraction service.

Configura il servizio di estrazione on page 2546
5. Configure IQ Bot for the selected extraction service.

Configure IQ Bot for extraction service on page 2547
6. Build a data extraction model.

Creare un modello di estrazione on page 2548
7. Log in to IQ Bot and create a learning instance.

Create a learning instance for standard forms on page 2549
8. Add validation rules for standard forms learning instance.

Define validation rules for standard forms learning instance on page 2550
9. Transfer the third-party extraction models

Transfer third-party extraction service models on page 2548
10. Move standard forms learning instance across different IQ Bot environments.

Transfer standard forms learning instance on page 2552
11. Upload documents in IQ Bot.

Upload documents for standard forms learning instance on page 2551
12. Validate the processed documents for standard forms learning instance.

Use the IQ Bot Validator on page 2530
13. Download the content extracted from standard forms.

Download extracted content on page 2552
14. Review the performance report and document processing information.

Revisione del dashboard on page 2533
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Workflow map: Click the following schematic image to view the Standard forms workflow in an

interactive visual format:
1.

Related concepts
IQ Bot user personas and roles on page 2476
Learn about the users that contribute to IQ Bot and the associated roles and licenses. IQ Bot users and
roles are defined in the Control Room.

Evaluate your use case
Content extraction models can be integrated into IQ Bot for extracting data from specific type of
documents.
Before you proceed further with standard forms, evaluate your use case to determine if the content
extraction from standard forms suits your requirement. Use the following questions as a guide to
determine whether your use case needs Standard forms processing

What are standard forms? Fixed format type documents that have a defined
template, with very little or no variation in the
overall layout. Standard forms are also known as
structured documents, are generally characterised
by high density of information, and are typically
official or legal forms. The following table illustrates
some examples of standard forms:
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Tax form Medical form Legal form

Does the layout of your documents vary
across vendor?

If yes, then this use case for content extraction
using standard forms is not the best option.

Are the positions of the various data
elements (checkboxes, tables, and so on)
fixed in your documents?

If no, then these are not standard forms and this
type of content extraction is not suitable.

Is the document a dynamic form? For
example, you have documents where the
values depend on other data elements.

If yes, then content from such documents cannot
be processed using standard forms content
extraction.

Is the document in a supported language? Consulta Azure Form Recognizer Supported Languages.
If no, then the document cannot be processed as a
standard form.

Does the documents have repetitive sections? If yes, then this is not a standard forms use
case. However, if there are a fixed number of
such repetitive sections that do not vary between
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documents, then it can be processed as a standard
forms.

Does your documents contain tables that
have a different number rows and columns?

If yes, then these documents cannot be considered
as standard form. The number of rows and columns
have to be fixed for standard forms.

Can document layouts that vary per year be
considered as standard forms? For example, a
W-4 document in 2020 and W-4 document in
2021?

If the document layout does not vary within the
same year or vary across organizations, then it
can be considered as standard forms. If there
are layout variations across years, then different
standard form models must be used to process
these documents.

Rivedi il servizio di estrazione
After you have confirmed that the documents you want to extract content from are standard forms, you
can then plan the type of standard forms extraction service that fits your requirement.
The following technologies are available for processing standard forms:

IQ Bot extraction service

This is a template based extraction service that uses OCR and heuristics to extract content from standard
forms. You have to train one template per standard form.
Guidelines for using IQ Bot extraction service
• Documents are of good quality (300 dpi)
• Document content is not very dense
• Input documents do not have any handwritten copies (limited support)
• Signatures are currently not supported
• Contains simple table layout (span within a page) with clear header, table boundaries, and so on
• Does not contain any tables or content that have checkboxes (limited support)
• Does not have any repeated sections (limited support)

Benefits of IQ Bot extraction service
• An integrated and simple out-of-the-box setup
• Various OCR engines to increase accuracy of extraction
• Complex layouts (repeated sections, continuous tables etc) can be extracted for specific cases (needs

testing)
• Only requires IQ Bot license

Microsoft Azure Form Recognizer service

Third party technology, that provides custom built Artificial Intelligence (AI) models to extract content from
standard forms. You can create custom models where documents can be labelled and trained.
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Guidelines for using Microsoft Azure Forms Recognizer service
• Input documents:

• can be dense (contain lot of details and information) and have a reasonable quality (>200 dpi)
• can contain checkboxes and radio buttons
• can have handwritten content
• can contain signatures
• can contain tables

The input documents can also contain tables that span over a single page. However, if the standard
forms contain table that span across multiple pages, the content extraction can fail.

• None of the sections in the input documents are not repeated
• Documents that contain transpose tables

Benefits of Microsoft Azure Forms Recognizer service
• Diverse standard form type documents can be processed
• Auto detection feature can identify different types of tables such as header-less table, inverted tables,

and so on
• Good support for handwritten forms

Rivedi i prerequisiti per l'implementazione
After you have finalized the type of extraction service that suits your requirement, ensure that you review
the prerequisites before proceeding with the implementation of the service.

IQ Bot extraction service

Review the operating system and database compatibility, database information, and various hardware and
software requirements as part of prerequisites for using IQ Bot extraction service.
Consulta Requisiti di sistema di IQ Bot on page 1070.

Microsoft Azure Form Recognizer service

Review the prerequisites of Microsoft Azure Form Recognizer service installation for standard forms.
• Cloud setup and installation

No additional configurations are required. However, based on the page processing volumes, the
Transactions Per Second (TPS) must be increased for the Microsoft region where your service is
running. Contact your Customer Success Manager (CSM) or Partner Enablement Manager (PEM) with
the expected page volume and Microsoft region where the service is running to update the TPS.

• On-Premises setup and installation
Pre-requisite for Azure Container on-prem installation for Standard Forms (A-People login required)

Considerations for optimum performance
Review the considerations to capture the performance metrics of IQ Bot standard forms with a new Model
containing more number of forms or table fields.
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Test summary

• Performance test was run for 10000 COVID Form documents (two pages per document = 20000 pages)
on a single node IQ Bot server using a single Bot Agent (using IQ Bot Extraction package). This test
was conducted to benchmark the performance metrics such as processing time, Straight Through
Processing (STP), validation, and documents processed (#successful processed pages/documents and
#failed pages/documents).

• New Model (WalgreenComplete 3260b299-68b5-4118-87df-b313bd5c30f6) with 26 Form Fields & 8
Tables fields are trained and used for extraction.

• With new Model (WalgreenComplete 3260b299-68b5-4118-87df-b313bd5c30f6), all the documents
were moving to validation during extraction. To get STP we marked below 5 fields as optional for this
test: A2PatientSign, B2Date, B2Sign, Phone, InsuranceCard(Table)->Card Details.

• Total time take to process 20000 pages using single Bot Agent was 25 hours, 21 minutes, & 42
seconds. This was based on IQ Bot On-Premises Build 12350.

• Average time take to process single page using IQ Bot Extraction package on single Bot Agent is
approximate 4.56 seconds.

• Achieved STP: 100% and Accuracy: 100%.
• During our test execution, the requests were served by Microsoft standard forms services hosted in us-

west2 region.
• As confirmed, Microsoft team TPS (Transactions Per Second) supported by us-west2 region was 100

TPS

Note:  KPI (Key Performance Indicators) like processing time, STP, accuracy might vary based on the
regions where Microsoft standard forms service is hosted and its transactions per second (TPS) rate.

Infrastructure configurations

The following table lists the infrastructure configurations:

Server Parametri Valori

Server 1 [Web Server] Control Room Windows Server 2019 → 8vCPU, 16 GB
RAM, 512 GB Disk [Rackspace Platform]-
uee

Server 2 [Database] Database Windows Server 2019 → 8vCPU, 16 GB
RAM, 512 GB Disk [Rackspace Platform]

Server 3 [Application
Server]

IQ Bot Windows Server 2019 → 8vCPU, 16 GB
RAM, 512 GB Disk [Rackspace Platform]

Server 4 [Client] Bot Agent Windows Server 2019 → 4vCPU, 8 GB
RAM, 256 GB Disk [Rackspace Platform]

Product configurations

The following table lists the product configurations:

Parametri Valori

Automation Anywhere Enterprise Automation 360 Build 12313

Bot Agent 21.80.10273

© 2023 Automation Anywhere. All rights reserved.     2544



    Automation Anywhere - Digitalizzazione

Parametri Valori

IQ Bot A360.24.28441-20220311

IQ Bot Extraction package 1.0.0-20220307-024320

Database Microsoft SQL Server Developer (64-bit)

Protocollo HTTPS

Network services Non-Active Directory

Data configurations

The following table lists the data configurations:

Parametri Valori

Dominio Standard forms

Provider Forms Extractor Type 1

Modello WalgreenComplete 3260b299-68b5-4118-87df-b313bd5c30f6

Tipo di documento Multi page PDF document

Pagine Two pages per document

Form Fields 26
[A2Date, A2PatientSign, Address, Age, B2Date, B2Sign, City,
DOB, Email, FirstName, LTCFName, LastName, Phone, PrintName,
Race-American, Race-Asian, Race-Black, Race-Native, Race-
Other, Race-UnableToReport, Race-Unknown, Race-White,
RefusedInformation, State, VaccinationType, Zipcode]

Table Fields 8 tables, 23 table fields
Table1: DriversLicense[Issuance, LicenseNo]Table2:
Ethnicity[Hispanic, NotHispanic, UnableToReport,
Unknown]Table3: Gender[Female, Male]Table4:
InsuranceCard[Card Details, Medical Card, Pharmacy
Card]Table5: MedicareDetails[Medicare, Medicare
PartB]Table6: PatientCardHolder[DontKnow, No, Question,
Yes]Table7: PatientType[Resident, StaffMember]Table8:
ScreeningQuestions[DontKnow, No, Question, Yes]

Configurazione COVID forms

# of Documents 10000

# of Pages 20000

Lingua English

Test results

The following table lists the test results:
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Parametri Valori

Total Documents Uploaded 10000

Total Pages Uploaded 20000

Total Processed documents 10000

Total Processed pages 20000

Operazione riuscita 10000 documents

Pending Review (Validation) 0

Elaborazioni interamente automatizzate 100%

Precisione 100%

Processing Time 25 hours, 21 minutes, and 42 seconds

Resource consumption data

The following table provides the resource consumption data:

Parametri CPU Utilization in % Memory Utilization in %

IQ Bot Average: 3,4
Maximum: 26,8

Average: 70,9
Maximum: 78,9

Control Room Average: 1,4
Maximum: 14,5

Average: 83,3
Maximum: 84,8

Database Average: 3,3
Maximum: 20,6

Average: 91,5
Maximum: 94,1

Bot Agent (Extraction) Average: 4,8
Maximum: 48,9

Average: 52,4
Maximum: 58,7

Configura il servizio di estrazione
To extract content from standard forms, you must setup and configure an extraction service. Review this
topic to understand how to setup each of the extraction service.

IQ Bot extraction service

No specific setup is required for content extraction through IQ Bot service. Ensure that you have access to
an active IQ Bot environment so that you can create a learning instance.
Consulta Creare un'istanza di apprendimento on page 2487.
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Microsoft Azure Form Recognizer service

1. Subscribe to Microsoft Azure service
Microsoft provides the Azure Form Recognizer service. Questo servizio consente di creare un
software di elaborazione dati automatizzato in grado di identificare ed estrarre contenuti specifici dai
documenti. You must have Microsoft Azure subscription in order to access Azure resources (OCR,
Form Recognizer), Automation Anywhere provides access to these resources through its subscription.
Contact your Customer Success Manager (CSM) or Partner Enablement Manager (PEM) who will help
you setup the services.
Request access for Microsoft Azure resources (OCR and Form Recognizer) (A-People login required)

2. Setup Microsoft Azure Form Recognizer service
a. For Cloud deployment

• If you have Automation Anywhere subscription, no additional configurations or changes are
required.

• If you have Microsoft Azure subscription, review the following article to setup and configure
your Microsoft Azure Form Recognizer for extracting content from standard forms.
Setup Azure Form Recognizer and Storage (Cloud) (A-People login required)

b. For On-Premises deployment
Setup Azure Form Recognizer and Storage (On-Premises) (A-People login required)

Configure IQ Bot for extraction service
IQ Bot must be connected to the extraction service for processing standard forms. The following section
provides details on how to configure IQ Bot for the selected extraction service. However, your IT Service
team can help you setup and configure the extraction service in IQ Bot.

IQ Bot extraction service

If you choose IQ Bot extraction service, no additional configurations are required.

Microsoft Azure Form Recognizer service

If you choose the Microsoft Azure Form Recognizer service, you must add Microsoft Form API and the
corresponding configurations in IQ Bot.
How to Setup and configure standard forms in IQ Bot (A-People login required)

Create the model in Document Automation

In Automation 360 v.26, you can configure the extraction model in the Control Room:
Create standard form in Document Automation on page 2603

© 2023 Automation Anywhere. All rights reserved.     2547

https://apeople.automationanywhere.com/s/article/How-to-request-access-for-Azure-resources-OCR-Form-Recognizer
https://apeople.automationanywhere.com/s/article/Setup-Azure-Form-Recognizer-and-Storage
https://apeople.automationanywhere.com/s/article/Azure-Container-on-prem-installation-for-Standard-Forms
https://apeople.automationanywhere.com/s/article/Setup-and-configure-standard-forms-in-IQ-Bot


    Automation Anywhere - Digitalizzazione

Creare un modello di estrazione
Data extraction model typically leverages Artificial Intelligence (AI) and Machine Learning (ML)
technologies to accurately extract text, key-value pairs, and tables from documents.

IQ Bot extraction service

Requires no separate AI model as this will be done as part of creating and training a learning instance in
IQ Bot.
Consulta Creare un'istanza di apprendimento on page 2487.

Microsoft Azure Form Recognizer service

During your use case evaluation, Microsoft Azure Form Recognizer models can be created by Sales
Engineering. But for any production deployment, contact Professional Services, or Partner Enablement
Manager (PEM) at Automation Anywhere.
How to Create and train Azure Form Recognizer model (A-People login required)

The benchmarks for the time taken for labeling fields in the Microsoft Azure Form Recognizer service are as
follows:
• Up to 30 fields: 1 ora
• 30 to 100 fields: 2 ore
• 100 to 400 fields: 4 ore

Note:  While creating a model, ensure there are no duplicate model names. And while creating a table,
ensure that the table name does not contain a space. For example, Sales chart.xls.

Transfer third-party extraction service models
Third party extraction models can be transferred from one subscription to another. Contact your
Automation Anywhere Customer Success Manager (CSM) for assistance.

IQ Bot extraction service

If you are using IQ Bot extraction service, no changes required.

Microsoft Azure Form Recognizer service

• Transfer models from one On-Premises to another On-Premises environment.
Transfer models from one environment to another (On-Prem) (A-People login required)

• Transfer models from one Cloud to another Cloud environment.
Transfer models from one environment to another (Cloud) (A-People login required)
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Note:  You can transfer standard forms learning instance along with an associated model between your
IQ Bot instances using API configurations. Per ulteriori informazioni, vedi  Transfer standard forms learning
instance and associated model (A-People login required)

Create a learning instance for standard forms
Learning instance is used in IQ Bot to extract, train, validate content from standard forms. Use the
following instructions to create a learning instance for processing standard forms in IQ Bot

Using IQ Bot extraction service
Ensure that you have access to an active IQ Bot environment so that you can create a learning instance.
Consulta Creare un'istanza di apprendimento on page 2487.

Using Microsoft Azure Form Recognizer service

1. Dal menu a discesa Tipo di documento, seleziona Moduli standard.
2. Nella scheda Impostazioni modulo standard, dal menu a discesa Nome del fornitore, seleziona

un fornitore per l'elaborazione del modulo.
3. Dal menu a discesa Tipo di configurazione, seleziona la configurazione supportata.

Questo consente di connettersi a uno dei servizi del fornitore configurati durante l'installazione.
4. Dal menu a discesa Seleziona modello, seleziona un modello pre-formato per la configurazione

selezionata.
5. Fai clic su Sfoglia per caricare un documento di riferimento.

Ad esempio, se è stato selezionato il tipo di configurazione e il modello fattura, è possibile caricare un
file fattura da analizzare.

Note:  Il documento di riferimento è solo una rappresentazione del tipo di documento da cui si
desidera estrarre i dati.

6. Nella scheda Campi da estrarre, seleziona i campi da cui estrarre i valori.
I campi vengono visualizzati in base al set di moduli selezionato nel modello pre-formato e non è
possibile aggiungere altri campi.

7. Fai clic su Crea un'istanza ed esegui l'analisi.
Il sistema analizza e ordina il documento in un gruppo logico.

Note:  Viene creato un solo gruppo predefinito. La regione identificata dal sistema (SIR) non è visibile
e tutti i campi relativi alla formazione sono disattivati. As the standard forms learning instance contains
pre-trained model, no additional training of the group is available. È possibile aggiungere solo modelli
di convalida e logica personalizzata.

After you have created a learning instance, you must add a group specific to standard forms.
8. On the Learning Instance details page, click Add group.
9. Create group label as <Standard Forms layout name>.

For example, if you have W-4 documents for the year 2021, enter W4_2021.
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10. Fai clic su Salva.
11. Open the system generated group
12. Click Delete Bot.

System generated group is removed from the Learning instance details page

Modificare un'istanza di apprendimento moduli standard
Poiché le istanze di apprendimento create utilizzando i moduli standard hanno configurazioni preimpostate,
è possibile modificare solo il nome e la descrizione. Inoltre, non è possibile modificare le istanze
nell'ambiente di produzione senza spostarle nell'ambiente di gestione temporanea.

Note:  Se si desidera modificare il modello associato a un'istanza di apprendimento, è necessario creare un
nuovo modello e seguire queste istruzioni:
1. Crea un'altra istanza di apprendimento simile a quella precedente.
2. Associa il nuovo modello a questa istanza di apprendimento.
3. Seleziona tutti i campi selezionati nell'istanza di apprendimento precedente.
4. Aggiorna le regole di convalida.
5. Sposta l'istanza di apprendimento in produzione e associa un bot a questa istanza di apprendimento.

1. Nella pagina Le mie istanze di apprendimento, seleziona l'istanza di apprendimento che si
desidera modificare.
È inoltre possibile utilizzare la barra Cerca per individuare l'istanza di apprendimento.

2. Fai clic su Modifica.
3. Modifica il nome dell'istanza di apprendimento nel campo Nome dell'istanza.

Le opzioni di classificazione dei documenti non sono disponibili poiché i moduli standard utilizzano
modello e configurazioni pre-formati.

4. Optional: Utilizza la scheda Gruppi di documenti per esaminare i gruppi associati all'istanza di
apprendimento.

Note:  The Add group button is not available as adding groups is not supported for a standard forms
learning instance.

5. Optional: Fai clic sulla scheda Riepilogo per rivedere l'istanza di apprendimento.
In questa scheda sono disponibili dettagli dei moduli standard come Fornitore, Configurazione e
Modello.

6. Fai clic su Salva.
Le modifiche apportate all'istanza di apprendimento vengono aggiornate nella gestione temporanea.

Define validation rules for standard forms learning instance
Per evitare un'estrazione dei dati errata o non valida, è possibile modificare il bot associato a qualsiasi
istanza di apprendimento di moduli standard e personalizzare le regole di convalida.
È possibile modificare solo un bot in gestione temporanea. So ensure that you move any bot that you want
to edit to staging if it is in production.
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Using IQ Bot extraction service

Use IQ Bot Designer to train a learning instance and extract content from sample documents. Review each
field to ensure the correct value is extracted and where necessary, map the correct field.
Per ulteriori informazioni, consulta Formare un'istanza di apprendimento on page 2498.

Using Microsoft Azure Form Recognizer service

1. Nella pagina Bot, seleziona il bot che desideri modificare.
È inoltre possibile utilizzare la barra Ricerca per individuare il bot.

2. Click the Edit Bot icon.
3. Nella colonna Campo, fai clic su Opzioni del campo.
4. Immetti eventuali regole di convalida personalizzate nei campi della scheda Convalida il modello.

I documenti non elaborati vengono spostati nel Validator e i campi con errori vengono
contrassegnati. È possibile rivedere i campi contrassegnati nel Validator.
Use the IQ Bot Validator on page 2530

5. Immetti la logica di post-elaborazione nella scheda Logica e fai clic su Salva.
6. Fai clic su Salva.

Il bot aggiornato viene salvato in gestione temporanea ed è possibile spostarlo in produzione.

Upload documents for standard forms learning instance
Upload your documents to IQ Bot for an existing standard forms learning instance for content extraction.
For extracting content from a single document, use the Upload Document action from IQ Bot package in
RPA Workspace.
See.Upload document action on page 1663
For content extraction from multiple or large number of documents, you can use the Process documents
action from IQ Bot Extraction package in Control Room. Use the following instructions to upload multiple or
large number of documents:
1. Trascina l'action Elabora documenti nel flusso di lavoro.
2. Click the Learning instance name drop-down menu and select a standard forms learning instance.
3. In the Desktop folder tab, enter the file path for the input folder or click Browse to select it.
4. Seleziona la cartella di output dal campo Percorso della cartella di output.
5. Seleziona la casella di controllo Invia documenti a IQ Bot Validator per la convalida.

Although the documents are processed using Bot Runners on your local machine, you must use this
option if you want to validate the documents in the Validator

6. Fai clic su Salva.
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Download extracted content
After you have trained learning instance, use the Download all documents action from the IQ Bot
package to download extracted content from standard forms.
1. Drag the Download all documents action from the IQ Bot package.
2. Click the Learning instance name drop-down menu and select a standard forms learning instance.
3. In the Local output folder field, provide a path to your local folder where you want to extract the

content.
4. In the IQ Bot Document status, select the appropriate status for the documents:
5. Select Delete files from the server after downloading check box if you want to remove the files

from IQ Bot server.
6. Nel campo Salva la risposta alla variabile aggiungi una variabile.

A variable value in this field provides information if the download was successful or the reason for a
failure.

7. Click Save, and run the bot.
8. Vai alla cartella di output locale per esaminare i file scaricati.

The output folder can have up to three subfolders:
• Ripetizione: contiene documenti inviati per la convalida.

Questi documenti vengono archiviati nel formato di input originale e puoi prepararli caricandoli
nell'istanza di apprendimento esistente.

• Operazione riuscita: Standard form documents that have been processed successfully.
The output is a .json file. Tables in the input documents are auto extracted and saved as
separate .xls file with the table name.

• Convalida: contiene documenti che richiedono la convalida.
These documents will be available in the IQ Bot Validator and you can download the output
separately.

Note:  Depending on the content in the uploaded documents, you can also get the following
additional subfolders:
• Failed: Documents that failed the validation process.
• Non elaborato: Documents that could not be classified.

Transfer standard forms learning instance
A standard forms learning instance is similar to the regular IQ Bot learning instance that describes the data
in a single document type, for example an invoice. It contains information such as the language used in
the documents and the fields to extract.
• Ensure that the source and destination systems are running the same IQ Bot version. Learning

instances from different IQ Bot versions cannot be imported because their database schema will not
match.

• Back up your database before importing learning instances.
• Export the .iqba file from the source IQ Bot environment.
• Import the .iqba file into the destination IQ Bot environment
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Related concepts
Manage learning instances on page 2527
A learning instance is an IQ Bot structure that describes the data in a single document type, for example
an invoice. It contains information such as the language used in the document and the fields to extract.

Esportazione di un'istanza di apprendimento di moduli standard
Standard forms learning instance can be used across similar IQ Bot environments. Esporta un'istanza di
apprendimento esistente per evitare di crearne un'altra con le stesse configurazioni.
L'amministratore di IQ Bot può utilizzare le seguenti istruzioni per modificare un'istanza di apprendimento
di moduli standard:
1. Fai clic su Amministrazione > Migrazione.
2. Fai clic su Crea backup.

Il backup dell'istanza di apprendimento esistente consente di salvare e ripristinare la configurazione,
se necessario.

3. Seleziona le istanze di apprendimento di cui desideri eseguire il backup, quindi fai clic su Backup.
4. Immetti un nome per il file di archivio (IQBA) IQ Bot.

Al nome del file di archivio viene aggiunto un timestamp per renderlo univoco. Puoi scaricare questo
file ed esportarlo nell'ambiente di destinazione.

5. Fai clic su Backup per avviare il processo di esportazione.
Il file di dati esportato con estensione .iqba è disponibile nella cartella BackupData nella tua
directory di output IQ Bot .

Importazione di un'istanza di apprendimento di moduli standard
Importare un'istanza di apprendimento esistente da un ambiente simile per evitare di creare istanze di
apprendimento e bots associati più volte. Utilizza la funzione Utilità di migrazione Automation 360 IQ Bot
per importare le istanze di apprendimento dei moduli standard.
Ensure that you have migrated the associated configuration to the target server before importing a
learning instance.
When you export an .iqba file, only a single document associated with every available bot (Group)
training is exported.
1. Accedi a IQ Bot come amministratore.
2. Fai clic su Amministrazione > Migrazione.

Viene visualizzato un elenco di istanze di formazione di cui è stato eseguito il backup.
3. Fai clic sull'icona Importa nella scheda Azioni per l'istanza di apprendimento selezionata.
4. Seleziona il metodo di importazione e fai clic su Accetta.

The selected standard forms learning instance is imported and is displayed under in My learning
instances page.

Document Automation
Document Automation è la nuova soluzione nativa del Cloud per l'elaborazione intelligente dei documenti
che gli utenti aziendali possono impostare per leggere ed elaborare automaticamente e rapidamente i
documenti utilizzando modelli preaddestrati e feedback di convalida.
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Document Automation è completamente integrato in Automation 360: Document Automation è installato
come parte del sistema Control Room, mentre gli RPA bots vengono utilizzati per estrarre dati semi-
strutturati per automatizzare i processi aziendali incentrati sui documenti e Automation Anywhere Robotic
Interface gestisce il processo di estrazione end-to-end e le attività di convalida.

Il flusso di lavoro Document Automation consente agli utenti di scalare le operazioni di elaborazione dei
documenti. Gli utenti creano istanze di apprendimento che utilizzano modelli preformati di Automation
Anywhere o Google Document AI per elaborare fatture, bollette e ricevute. Una volta che l'istanza di
apprendimento viene eseguita in fase di produzione, migliora automaticamente l'accuratezza dell'estrazione
in base al feedback della convalida manuale.
Per un confronto fianco a fianco delle funzionalità di Document Automation e Automation 360 IQ Bot,
consulta Intelligent Document Processing solutions feature comparison matrix on page 2561.
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Impostare l'ambiente Document Automation

Document Automation è installato insieme a Control Room e condivide il database Control Room. Non ci
sono attività di installazione aggiuntive per i clienti Control Room Cloud.
Per iniziare a usare Document Automation devi prima configurare gli utenti, i ruoli e i dispositivi e collegare
la Control Room a Automation Anywhere Robotic Interface:
Set up your Document Automation environment on page 2562

Note:  Per installare Document Automation in un server On-Premises, tieni presente quanto segue:
• The Control Room stores Document Automation output data.
• You must install the Control Room in a configuration that points to the location where Document

Automation data is stored. Ensure there is sufficient storage space.
• The minimum necessary storage space depends on the processing volume, document size, and use

case. As a guide: an environment that processes 100,000 pages per month, with a 30-day data
lifespan, requires 500 GB of storage space.

Utilizzo di Document Automation

Workflow map: Click the following schematic image to view the  workflow in an interactive visual

format:
1.

Di seguito una panoramica del processo end-to-end per creare, configurare e pubblicare un'istanza di
apprendimento in Document Automation:

Passaggio 1: Creare un'istanza di apprendimento Accedi a Control Room come utente creatore
dell'istanza di apprendimento e crea un'istanza di
apprendimento per estrarre i valori dai documenti.

Passaggio 2: Elaborare i documenti Carica i documenti nell'istanza di apprendimento per
testare il modello, correggi gli errori di convalida e
verifica i dati estratti.

Passaggio 3: Build a bot to upload documents to
Document Automation on page 2587

Costruisci un bot che carica i documenti da una
cartella sorgente a Document Automation.

Passaggio 4: Publish the learning instance on page
2586

Check-in the learning instance assets (process,
form, and bots) to the public repository. Then,
deploy the process and bots to unattended Bot
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Runner devices to begin processing documents in
real time.
Dopo che il processo è stato distribuito, i documenti
in arrivo vengono elaborati e Document Automation
estrae i dati dai documenti o invia i documenti per
la convalida.

Passaggio 5: Convalidare i documenti caricati Accedi come utente Validator, apri la coda di
convalida e utilizza il Validator per correggere gli
errori.

Related concepts
Document Automation utenti on page 2564
With the required roles, permissions, and licenses, Document Automation users can perform various tasks.
Users and roles are defined in the Administration tab.
Related tasks
Set up your Document Automation environment on page 2562
Document Automation is installed simultaneously with the Control Room. Configure the users, roles, and
devices, and connect the Control Room with Automation Anywhere Robotic Interface.
Related reference
Domande frequenti su Document Automation on page 2558
Answers to frequently asked questions (FAQs) on the latest Automation Anywhere intelligent document
processing solution, Document Automation.
Related information
Document Automation Developer Training (A-People login required)

Document Automation architecture
Document Automation uses features from the Control Room and Automation Anywhere Robotic Interface,
as well as some third-party products.
The following architecture graphic demonstrates the flow of data in the intelligent document processing
workflow for the two possible deployment scenarios:
• The Learning instance creator uploads documents to the Document Automation interface, for example

to test the extraction capabilities of the learning instance.
• An Unattended Bot Runner deploys the Scheduler Bot to upload and process the documents.

The graphic also shows the scenarios where data is sent to third-party products, such as for Google
Document AI or Standard Forms extraction.
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Control Room to regions mapping

Document Automation is supported on AWS and Google Cloud Platform.
For customers who configured Document Automation with Google Document AI licenses
purchased from Google: Documents uploaded to Document Automation for processing in Google
Document AI are sent to the Apigee gateway that you configured when you created the processor in
Google Document AI.
For customers who purchased Google Document AI product licenses from Automation
Anywhere: Google Document AI uses the Apigee API gateway to manage the document processing APIs.
When a document uploaded to Document Automation is sent to Google Document AI, data is sent to the
Apigee gateway that corresponds with your AWS or Google Cloud Platform region.

Apigee gateway AWS/Google Cloud Platform regions

Stati Uniti • US-East
• US-Central
• US-West
• CAN
• LATAM

Europe • EU-West1
• Europa occidentale4
• ME
• S-Africa
• AP-Aus
• AP-Singapore
• AP-JP
• India

Related concepts
Data extraction in Document Automation on page 2570
Understand how the system improves extraction accuracy though user-provided changes in the Validator.
Informazioni su Automation 360 on page 11
La piattaforma per forza lavoro digitale Automation Anywhere è la base per fornire automazione del lavoro
aziendale complesso in modo sicuro e su vasta scala. Automation 360 è una piattaforma per forza lavoro
digitale e RPA leader del settore che combina un'interfaccia utente di facile utilizzo con l'affidabilità di
classe enterprise e la sicurezza per consentire l'auto-automazione in tempo reale.
Related reference
About the AARI process in Document Automation on page 2574
Document Automation uses Automation Anywhere Robotic Interface technology to manage the end-to-end
document extraction process. When you create a learning instance in Document Automation, the system
also creates an AARI process. Review the following guide to understand the logic.

Domande frequenti su Document Automation
Answers to frequently asked questions (FAQs) on the latest Automation Anywhere intelligent document
processing solution, Document Automation.
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Product FAQ

What pre-trained models are included? Automation Anywhere offers invoices and Google
Document AI offers invoices, utility bills, and
receipts.

Does Document Automation have feature
parity with Automation 360 IQ Bot?

Document Automation supports the following
features from Automation 360 IQ Bot:
• Data extraction from text, number, date time,

and check box fields
• Validation rules based on patterns, formulas,

lists, and statements

Which browsers are supported? Document Automation is supported on the same
browsers as the Automation Anywhere Control
Room: Google Chrome, Microsoft Internet Explorer,
and Microsoft Edge.

Note:  If you use Document Automation in Firefox,
the user interface might not behave as expected.

What languages are supported? Document Automation supports English, Dutch,
French, German, Italian, Portuguese (Brazilian), and
Spanish.

Note:  Extraction for French, German, and Spanish
language documents is currently in preview.
Extraction results will improve in future releases.

You can process documents in other languages by
creating and training a training a learning instance
in Automation 360 IQ Bot and connecting it with
Document Automation to process documents using
Document Automation technology and workflow.
Per ulteriori informazioni, consulta Connetti l'istanza
di apprendimento on page 2584.

What file formats are supported? Document Automation can process documents in
the following file types:
• PDF
• JPG
• JPEG
• PNG
• TIF
• TIFF

Which licenses are necessary? The IQ Bot Pages product licenses is necessary
for processing documents. The Automation
Anywhere Robotic Interface license is necessary
for processing documents in learning instances in
production.
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To send documents to Google Document AI
for extraction, you must also have the Doc AI
 Document product license.

Note:  To configure the Control Room with your
Google Document AI license key, you must do
these steps: Configure key for Google Document AI on
page 2566. These steps are not necessary if you
purchased Doc AI Document licenses through
Automation Anywhere.

We provide a recommendation on configuring
users with the minimum necessary roles and device
licenses to perform specific tasks in Document
Automation utenti on page 2564.

Can learning instances be migrated from
Automation 360 IQ Bot to Document
Automation?

Users can connect their learning instances
from Automation 360 IQ Bot to their Document
Automation environment, which allows them to
process documents using the Document Automation
technology without having to rebuild the learning
instances. Per ulteriori informazioni, consulta
Connetti l'istanza di apprendimento on page 2584.

Are customers required to maintain their
Automation 360 IQ Bot environments?

If you have connected a learning instance
from Automation 360 IQ Bot to Document
Automation, do not delete the learning instance
from Automation 360 IQ Bot since it stores the
training data.
We recommend you maintain Automation 360 IQ
Bot in a version compatible with the associated
Control Room.

What learning instance fields are supported
out of the box?

Document Automation offers over 35 of the most
common invoice fields, with the option to configure
custom fields. To see all the possible fields when
you are creating a learning instance, click Show
unused fields.

Processing and extraction FAQ

Which OCRs are supported? The Automation Anywhere pre-trained model uses
the ABBYY FineReader Engineor the Google Vision
OCR.

I uploaded documents for processing, but
nothing is happening.

The first time you process documents, the
Document Extraction package downloads to the
local device. This might cause a delay in document
processing.

What should I do if a folder contains
documents in multiple languages?

Use the IQ Bot Classifier package to sort the
documents by language, then create a learning
instance for each language.

How do I process documents using Google
Document AI?

Document Extraction enables users to send their
documents to Google Document AI for processing.
To use this feature, users must have Document
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AI licenses that they either purchased from
Automation Anywhere or provided their Google
Document AI account credentials to the Control
Room.
The process of creating, testing, and publishing
is the same for learning instances using a Google
Document AI model as for learning instances using
a pre-trained model from Automation Anywhere.

Are multi-page tables supported? Yes, Document Extraction supports extracting tables
that span across multiple pages.

Is it possible to extract multiple tables from a
document?

At this time, Document Automation can extract one
table per document.

Where can I see the reason why data was not
extracted from an uploaded document?

The AARI Requests tab holds the history for each
uploaded document. Here, you can see the step at
which extraction failed or if a Validator user marked
the document as invalid.

Is currency extraction supported? Yes, except for the rupee (₹).

Intelligent Document Processing solutions feature comparison
matrix
Review the differences between Automation 360 IQ Bot and Document Automation by comparing the
features in them.

Automation 360 IQ Bot Document Automation

Amministrazione e impostazione

Installazione Installatore separato Installato come parte della
Control Room

Amministrazione del database Database separato; richiede uno
sforzo aggiuntivo per i backup e
la manutenzione

Utilizza il database Control
Room; nessun backup o
manutenzione aggiuntivi
necessari

Configurazione del server Requires additional SSL
configuration, RabbitMQ
administration, HA and DR

Pronto all'uso

Configurazione dell'istanza di apprendimento

Gestione degli alias (parole
chiave)

No way to add or remove field
aliases for domains, only for
document groups

Users can view, add, or remove
field aliases for the learning
instance

Soglia di attendibilità Does not work out of the box;
server-level configuration

Helps to catch false positive
outcomes; field-level
configuration

Personalizzazione dell'ordine e
del nome del campo

Not supported Consente di migliorare
l'efficienza della convalida

Configurazione del campo Must be done for every group Needs to be done only one time
for a learning instance
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Automation 360 IQ Bot Document Automation

Ability to add and remove fields
from the learning instance

No Sì

Extraction capabilities

Modelli preformati Domains required training Can process invoices, receipts,
and utility bills

Gestione delle variazioni dei
documenti

Classifier relies on document
layout and training. Documents
uploaded with a new layout are
sent to a new document group,
which requires training. Some
docs could not be classified.

Layouts are identified using
an object detection model to
find key-value pairs. It is not
necessary to configure all the
fields in a learning instance
before uploading documents.

Processo di formazione Each group needs to be
manually trained before it can
process documents

Learning instance extraction
improves based on changes
users make in the Validator

Output format CSV only CSV or JSON

Revisione e convalida umana

Validation queue management No Use filters and search to find
specific learning instances or
documents

End-to-end automation

Task bots Deve essere creato
manualmente

Control Room automatically
creates task bots for a learning
instance

See status and history of
uploaded documents

No Sì

Customizable document
processing workflow

No Sì

Sicurezza

Politica di conservazione No Supportato da archiviazione
AARI
See Cloud storage retention policy

Gestione segreta No Can use credential vault to store
Google Document AI credentials

Set up your Document Automation environment
Document Automation is installed simultaneously with the Control Room. Configure the users, roles, and
devices, and connect the Control Room with Automation Anywhere Robotic Interface.

1. Log in to Document Automation through the Control Room.
You will receive an email from Automation Anywhere with your URL and credentials. Open the Control
Room URL in your browser, enter your credentials in the login screen, and click Log in.
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2. Upload the Document Extraction package to the Control Room: Carica i pacchetti IQ Bot sulla Control
Room

3. Create a custom role that allows users to check in and check out bots, manage packages, and validate
documents.: Create a custom role for Document Automation on page 2564

4. Create the users necessary to complete the end-to-end process of creating and publishing a learning
instance: Document Automation utenti on page 2564

Note:  When creating the Unattended Bot Runner user, provide the device credentials. You will
connect the Unattended Bot Runner to the device in the next step.

5. Configure the unattended Bot Runner user device and device pool to allow the learning instance to
function in public mode:
a) Using Remote Desktop Protocol (RDP), open the virtual machine where the unattended Bot

Runner will run.
b) Log in to the Control Room as the Document Automation Admin user you created previously.
c) Vai a Gestisci > Dispositivi e fai clic su Connetti dispositivo locale. Segui i passaggi della

procedura guidata per collegare la Control Room al tuo dispositivo.
d) Fai clic su Aggiorna per verificare che il dispositivo sia collegato.
e) Click Create device pool and perform the following steps:

1. Enter a name for the device pool.
2. Click Devices and then the arrow to move the device to the Selected column.
3. Click Consumers and then the arrow to move aari-document-processor to the

Selected column.
4. Click Create device pool.

You can perform the following steps in the virtual machine or you can return to your device. If you
perform the following steps on your device, ensure that you log in to the Control Room as the Document
 Automation Admin user.
6. Open Automation Anywhere Robotic Interface to connect it with the Control Room.

a) Navigate to the AARI interface by adding /aari after your assigned Control Room URL.
b) Navigate to Manage > Process > Global scheduler and click Edit.
c) Select the Scheduler user that you created previously and click Save.

Viene visualizzato il seguente messaggio: Secure connection between AARI Web and
 Enterprise Control Room established successfully

7. Create a team in AARI to grant the Validator user access to the documents awaiting validation.
a) Navigate to Manage > Team > Create new team.
b) Enter a team name.
c) Select the Shared request visibility.
d) In the Users field, add the Validator user that you created previously and click Save.

If users will create learning instances that use the Google Document AI model and you did not
purchase Google Document AI licenses through Automation Anywhere, follow the steps to
Configure key for Google Document AI on page 2566.
Log in to the Control Room as the Learning instance creator user and begin creating learning
instances: Utilizzo di Document Automation on page 2555
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Related tasks
Installazione di licenze aggiuntive on page 2794
Carica le nuove licenze in Automation Anywhere Control Room da distribuire agli utenti come richiesto.
Related reference
Licenze Automation 360 on page 1010
La pagina Tutte le licenze mostra informazioni dettagliate sulle licenze correnti di prodotti e dispositivi.

Create a custom role for Document Automation
With a custom role, Document Automation users can check in and check out bots, manage packages, and
validate documents.

1. Navigate to Administration > Roles > Create role.
2. Provide a name for the role, such as aari-document-processor.
3. In the Feature permissions page, select the following:

• Visualizza i miei bot
• Esegui i miei bot
• Esporta bot…
• Importa bot…
• Crea cartelle
• Rinomina cartelle
• Cancella checkout

Pacchetti
• Visualizza pacchetti
• Gestisci pacchetti

Automation Anywhere Robotic Interface
• Lettura trasversale team
• AARI Scheduler

4. In the Bots permissions page, select all the check boxes in the Bots row.
5. Click Save to create the role.

Create users and assign this custom role to them. For more information about the required users, refer to
Document Automation utenti on page 2564.

Document Automation utenti
With the required roles, permissions, and licenses, Document Automation users can perform various tasks.
Users and roles are defined in the Administration tab.
The following table contains information about each type of user that interacts with Document Automation.
It includes a description of the tasks that each user performs, the required roles, permissions, and licenses,
and links to the pages most relevant to that user. Use this page to guide you in creating the users in the
table below: Create a user on page 2684

Note:  Some users require a custom role in Document Automation. This role grants users permissions to
check in and check out bots, manage packages, and validate documents. For instructions on how to create
a custom role, see Create a custom role for Document Automation on page 2564.
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Utente Descrizione Ruoli Licenza Related links

Creatore
dell'istanza
di
apprendimento

Can create, edit,
and delete learning
instances, upload
documents for
processing, and check
in or check out learning
instances.

AAE_IQ Bot
Services,
AAE_Basic,
and aari-
document-
processor
custom role

Bot Creator Creare un'istanza
di apprendimento in
Document Automation on
page 2567
Elabora documenti in
Document Automation on
page 2576
Publish the learning
instance on page 2586

Standard
Forms
model
creator

Creates an extraction
model.

AAE_IQ Bot
Services or
AAE_IQ Bot
Admin

Document
Automation
Standard Forms
(Number of
pages)

Create standard form in
Document Automation on
page 2603

Admin
Document
Automation

Deploys the AARI
process and RPA bots
to the unattended Bot
Runner, manages AARI
teams, and assigns
validation tasks to a
team

AAE_Admin,
AAE_Pool
Admin,
AAE_Locker
Admin, and
AAE_Robotic
Interface
Manager

-- Set up your Document
Automation environment
on page 2562
Creare un team AARI
e assegnare i ruoli ai
membri on page 2164
Publish the learning
instance on page 2586

Pianificatore Enables the Control
Room and AARI to
connect learning
instances in public
mode to AARI
processes.

Note:  This user is not
associated with a real
person.

AAE_IQ Bot
Services,
AAE_Basic,
and aari-
document-
processor
custom role

-- --
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Utente Descrizione Ruoli Licenza Related links

Bot
Runner
non
assistito

Runs the RPA bots for
learning instances in
public mode to upload,
process, and download
documents.

Note:  This user is not
associated with a real
person.

AAE_IQ Bot
Services,
AAE_Basic,
and aari-
document-
processor
custom role

Note:  Provide
the device
credentials when
you configure
this user. You
will connect the
Unattended
 Bot Runner
user to the
device in one of
the steps in Set
up your Document
Automation
environment on
page 2562.

Unattended
Bot Runner,
Automation
Anywhere
Robotic
Interface, and
the product
licenses
necessary
to upload
documents
to learning
instances in
production:
IQ Bot pages,
standard forms,
or Document AI
Document
processing product
licenses

--

Validator Validates documents
that were processed by
a learning instance in
public mode.

AAE_IQ Bot
Validator and
AAE_Robotic
Interface User

Automation
Anywhere
Robotic Interface

Convalidare i documenti
in Document Automation
on page 2597

Related tasks
Create a user on page 2684
Crea un utente e assegna il suo ruolo specifico basato su licenza.
Create a role on page 2693
As an administrator, you can configure roles with permissions to access features and perform operations
such as create, edit, or delete a bot in the Control Room, and assign the role to a user.
Related reference
Licenze Automation 360 on page 1010
La pagina Tutte le licenze mostra informazioni dettagliate sulle licenze correnti di prodotti e dispositivi.

Configure key for Google Document AI
If the learning instance uses a Google Document AI model and you did not purchase Google
Document AI licenses through Automation Anywhere, follow these configuration steps.
• If you have not done so already, complete the steps to Set up your Document Automation environment on

page 2562.
• Log in as the Admin user type. For more information about the user types, refer to Document

Automation utenti on page 2564.
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You will assign this role to a Credential Vault locker, which will allow the Learning instance creator
user to securely provide the Google Document AI key to the Extraction bot, allowing the learning
instance to send documents to Google Document AI for extraction.
Create a custom role to access the Credential Vault locker that holds the Google Document AI key:
1. Navigate to Administration > Roles > Create role.
2. Provide a name for the role, such as doc-ai-credential-role.

The Manage my credentials and lockers permission is automatically selected.
3. Click Create role.
Assign the role to the Learning instance creator and Unattended Bot Runner user types.
4. Navigate to Administration > Users and locate the users.
5. For each user, click Edit user and add the doc-ai-credential-role.
Create a credential to store the Google Document AI key:
6. Navigate to Manage > Credentials > Create credential.
7. Provide a name for the credential, such as doc-ai-credential.
8. Provide a name for the attribute, such as ServiceAccount.
9. Select the Standard input option and enter the Google Document AI API key in the Value field.
10. Click Create credential.
Create a locker to store the key and provide access to other users.
11. Navigate to the Lockers tab and click Create locker.
12. Provide a name for the locker, such as doc-ai-locker.
13. Select the doc-ai-credential and click the right arrow to move the credential to the Selected

column.
14. In the Consumers tab and select the doc-ai-credential-role and click the right arrow to move

the credential to the Selected column.
15. Click Create locker.

Log in as the Learning instance creator user type to do the following:
• Create a learning instance: Creare un'istanza di apprendimento in Document Automation on page 2567
• Provide the credential to the Extraction bot: Configure Extract action to process documents in Google

Document AI on page 1491

Related tasks
Installazione di licenze aggiuntive on page 2794
Carica le nuove licenze in Automation Anywhere Control Room da distribuire agli utenti come richiesto.
Related reference
Licenze Automation 360 on page 1010
La pagina Tutte le licenze mostra informazioni dettagliate sulle licenze correnti di prodotti e dispositivi.

Creare un'istanza di apprendimento in Document Automation
Begin processing documents by creating a learning instance to extract data from invoices, utility bills, or
receipts. Un'istanza di apprendimento è una struttura che contiene informazioni come il tipo di documento,
la lingua e i campi da estrarre.
• To create a learning instance, you must be a Learning instance creator user. Consulta Document

Automation utenti on page 2564.
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• To create a learning instance that uses a Google Document AI model, you must create a credential and
locker to hold your security token. Consulta Crea credenziali on page 2842 e Crea locker on page 2844.

Note:  When configuring the locker, you must add the aari-document-processor custom role as a
locker consumer.

• The default OCR is ABBYY FineReader Engine. Alternatively, Cloud Control Room users can create a
learning instance to process documents in Google Vision OCR.

Watch this video for the complete end-to-end process of creating a learning instance:
1. From the Control Room home page, navigate to Manage > Learning Instances > Create

Learning Instance.
2. Enter a name and description for the learning instance.

Document Automation does not allow duplicate learning instance names, so the name you provide
must be unique.

3. Select the document type: Invoice ,User-defined, Utility Bill, or Receipt
Use the user-defined document type to process documents that are visually similar to invoices, such
as purchase orders and sales orders, which contain key-value pairs and a table structure. In this
document type, you create and configure all of the form and table fields.

4. Select the language.
Document Automation supports English, Dutch, French, German, Italian, Portuguese (Brazilian), and
Spanish.

Note:  Extraction for French, German, and Spanish language documents is currently in preview.
Extraction results will improve in future releases.

5. If you selected Invoice: Select the provider.
If you selected the English language in step 4, Automation Anywhere (Pre-trained) is auto-
selected.

6. For learning instances with the Automation Anywhere (Pre-trained) provider, you can opt in to
send feedback to the system to improve extraction results. Per ulteriori informazioni, vedi Improving
extraction accuracy through validation on page 2571

7. Optional: Select the OCR provider. By default, Document Automation processes documents in ABBYY
FineReader Engine.
Users with a Cloud Control Room can select to process documents in Google Vision OCR.

8. Fai clic su Avanti.
We recommend that you open a sample document side by side with the Control Room window as you
configure the form and table fields.

Note:
• A form field is a type of field that occurs only once in a document.
• A table field is a type of field that reoccurs throughout a document, typically in the form of a table.

9. Configure the form and table fields for extraction.
Document Automation offers a standard set of form and table fields, many of which are not initially
visible. You can search for a field by field name, field label, or data type.
To see the full list of fields, click Show unused fields. See the following video for a demonstration:
Click a field to open the fields editor. You can edit most attributes of a field. You cannot edit the name
and default aliases. Document Automation assigns default aliases, which are hardcoded keywords, to
standard fields to help with extraction. You cannot modify or delete default aliases, but you can add
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aliases in the Custom aliases field. See the following video for a demonstration of creating a custom
alias:

Note:  Custom fields are not available for learning instances that use the Google Document AI
provider.

Mouse over the menu icon to the right of a field to access the up/down arrows. Use the arrows to
rearrange the order of the fields for a more efficient manual validation. L'ordine dei campi non influisce
sull'estrazione.
To learn more about the other field attributes, review the table in the next step.

10. Per aggiungere un campo, fai clic su Aggiungi campo e completa i seguenti campi:
Opzione Descrizione

Nome campo Immetti un nome di un campo che inizi con un carattere alfabetico (A-Z o a-z).
In standard fields, the field name is hardcoded and cannot be changed.

Etichetta del
campo

Immetti un nome intuitivo per aiutare i validator.
Ad esempio, è possibile rinominare il Codice fiscale
dell'organizzazione con un nome localizzato, ad esempio Partita IVA.
The field label does not affect extraction.

Attendibilità Imposta una soglia per ridurre i potenziali falsi positivi.
At the time of processing, the Document Automation engine assigns a score to
each field in a document to indicate the certainty that the data was correctly
extracted. Se il documento contiene campi con un punteggio inferiore alla soglia
di confidenza, il documento viene inviato alla coda di convalida.
If you enter a high confidence threshold, more documents will be sent to the
validation queue. If you enter a low confidence threshold, fewer documents will
be sent to the validation queue.
Supports values from zero to 100.

Tipo di dati Choose from Address*, Text, Number, and Date.
If the data in the field does not match the data type, the document is sent to
the validation queue.
Document Automation supports date and number format variations.
* If you are configuring a learning instance with a user-defined document type,
the form fields include the address data type, which extracts the entire structure
of an address.

Obbligatorie Seleziona una delle seguenti:
• Required: Field cannot be empty.
• Facoltativo: Field can be empty or not exist in the document.

Alias predefiniti Non è necessaria alcuna azione per questo campo. Document Automation
assigns default aliases, which are hardcoded keywords, to standard fields to
help with extraction.
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Opzione Descrizione

Alias
personalizzati

Additional keywords to help Document Automation locate the field. Ad
esempio, aggiungi nomi specifici per Paese o regione per campi come
Partita IVA come alias di un campo personalizzato Codice fiscale
dell'organizzazione.

Note:  Custom aliases must be unique. They cannot duplicate the default alias
of another field. Exception: Form fields can have duplicate custom aliases as
the table fields and vice versa.

Validation rules Depending on data type, create rules using patterns, formulas, lists, and
statements such as starts or ends with.
Convalida della formula on page 2580 | Pattern validation on page 2583

11. Fai clic su Crea.

When a new learning instance is created, the Control Room creates a folder with the
same name as the learning instance in the Automation > Document Workspace
folder. The folder contains two bots (extraction and download), a process, and a

form.
• Process: Gestisce il processo utilizzando scenari IF/Else attraverso i quali Document Automation estrae

i dati dai documenti caricati, assegna i documenti agli utenti per la convalida e scarica i dati estratti. To
learn more, see About the AARI process in Document Automation on page 2574

• Extraction bot: Extracts data from defined fields in the uploaded documents.
• Download bot: Consente di scaricare i dati estratti in una cartella specifica sulla periferica o sulla rete

condivisa.
• Form: Defines the input parameters that are sent to the process. I parametri di input includono il nome

dell'istanza di apprendimento, il file caricato e il percorso del file di output.

Carica documenti nell'istanza di apprendimento, correggi gli errori di convalida e verifica i dati estratti:
Elabora documenti in Document Automation on page 2576

Data extraction in Document Automation
Understand how the system improves extraction accuracy though user-provided changes in the Validator.
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Improving extraction accuracy through validation

When a learning instance is created, the user has the option to enable this feature to send feedback to
the learning instance based on user-provided changes in the Validator. In Document Automation, learning
instances running in production mode can continuously "learn" whenever a user resizes or relocates the
extraction region in the Validator.

Note:  This feature is available only for Automation Anywhere pre-trained models.

The following graphic provides a visual overview of the process by which learning instances continuously
receive feedback from validation:
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1. An uploaded document passes through the extraction engine.
2. If the learning instance successfully extracts the data, the document is added to the straight-through

processing (STP) count and the extracted values are downloaded to a file in the Success folder.
If the learning instance can not extract the data, the system evaluates whether the document contains
an unfamiliar layout.

3. If the learning instance does not recognize the document layout (new layout), the document is sent
for manual validation where the user "teaches" the learning instance how to extract the data by
setting the extraction region.
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4. The extracted values are downloaded to a file in the Success folder and the changes are collected in
a feedback file, which is sent to the feedback database.

Note:
• Feedback is only collected when the user changes the extraction region. If the user manually inputs

text, the system does not collect feedback.
• The feedback file only contains data on the field location to improve extraction accuracy for

subsequent documents.

If the learning instance recognizes the cluster, it retrieves previous feedback from the feedback
database and uses it to extract data.

Using validation feedback to extract specific values in a table

As of Automation 360v.27, you can train a learning instance to extract data from a cell that contains more
than one field.
For example, if a product description column also includes item number, you can outline the item number
in the Validation interface. When the learning instance processes subsequent documents, it will extract the
item number and ignore the product description.
Follow this process to configure a learning instance to extract specific values from a cell:
1. Create a learning instance using an Automation Anywhere pretrained model and select the option to

send validation feedback: Creare un'istanza di apprendimento in Document Automation on page 2567
2. Upload a sample document: Elabora documenti in Document Automation on page 2576
3. In the Validator, locate the field and redraw the box to only surround the values that you want to

extract.
4. After you click Submit, the information on the new extraction region is sent to the feedback

database.
5. Upload more documents to test the accuracy of extraction. When you are satisfied with the results,

proceed to preparing the learning instance to run in production: Publish the learning instance on page
2586

How Document Automation identifies new layouts

Document Automation extraction is based on object detection. During document processing, the extraction
engine identifies objects, or key-value pairs of the field and associated value. The engine creates a
"fingerprint" of the document, which stores the sequence of the objects and each object's location in the
document.
When a document is processed, if the engine recognizes the keys and their locations, the document is
classified and extracted based on that existing fingerprint. Otherwise, the engine saves a new fingerprint of
the keys and their locations.
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About the AARI process in Document Automation
Document Automation uses Automation Anywhere Robotic Interface technology to manage the end-to-end
document extraction process. When you create a learning instance in Document Automation, the system
also creates an AARI process. Review the following guide to understand the logic.
When a learning instance is in production, each incoming document creates a new request, which triggers
the extraction process. If a document requires manual validation, AARI creates a validation task and
assigns it to a validation team.
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After the documents are processed, the Download bot downloads the extracted data to a file in the
Success folder.
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1. Start: The AARI form that defines the inputs, such as the learning instance name, uploaded
documents, and output folder.

2. Bot Task ExtractionBot: Executes the RPA bot that processes input documents to extract data from
them.

3. Document Validator Task: Opens the Validation user interface where the user can manually
validate the fields in the document.

4. Documents require validation: The ExtractionBot tried to process the documents then sent
the documents for validation, the documents were successfully validated, and the DownloadBot
downloaded the extracted data to the Success subfolder.
Request status = VALIDATION_SUCCESS

5. Invalid documents: The previous process was interrupted at validation, where a user marked
certain documents as invalid. These documents were downloaded to the Invalid subfolder.
Request status = VALIDATION_INVALID

6. Reprocessed documents: The previous process was interrupted at validation because the user
clicked Reprocess. Documents were sent back to the ExtractionBot for reprocessing.
Request status = VALIDATION_REPROCESSING

7. Documents are successfully processed: The ExtractionBot successfully processed the documents,
no documents required validation, and the DownloadBot downloaded the exacted data.
Request status = success and STP

8. Processing failed: The ExtractionBot failed to process the documents (for example: invalid format or
could not read the file) and the file is saved to the Failed subfolder
Request status = FAILED

9. Deployment failed: The Control Room failed to deploy the ExtractionBot (for example: lost server
connection). The Control Room makes three attempts.

Important:  We do not recommend deleting the process. If you unintentionally delete a process
associated with a learning instance, do the following steps to recover the process:
1. Navigate to Manage > Learning Instances and mouse over the actions menu to the right of the

learning instance.
2. Click Export.
3. Mouse over the actions menu to the right of the learning instance and click Delete.
4. Click Import at the top of the page.
5. Click Browse and select the .dw file you exported.
6. When prompted, click Overwrite to generate a new process for the learning instance.

Elabora documenti in Document Automation
Upload sample invoices to test the learning instance, verify the extracted data, and fix validation errors.
• If you have not done so already, Creare un'istanza di apprendimento in Document Automation on page

2567.
• Verify that your device is connected to the Control Room: Installazione di Bot Agent e registrazione del

dispositivo on page 1039
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• If the learning instance uses a Google Document AI model and you did not purchase Google
Document AI licenses through Automation Anywhere, you must provide your Google Document
AI credentials to the Extraction bot. See Configure key for Google Document AI on page 2566

• If the learning instance uses an Automation Anywhere model, ensure that each file is 50 MB or less.
If the learning instance uses a Google Document AI model, ensure that each file is 20 MB or less, with
a maximum of 5 pages.

• Ensure that the sample documents are in one of the following supported document types:
• PDF
• JPG
• JPEG
• PNG
• TIF
• TIFF

• The default output format for the extracted data is CSV file. To change the output to JSON, see Change
output format from CSV to JSON on page 2580.
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Perform the following steps to upload sample invoices to the learning instance to test the data extraction
capabilities of the learning instance.
1. Upload documents to test the learning instance:

See these steps in a video:

a) Fai clic su Elabora documenti.

b) Nella finestra Elabora documenti, fai clic su Sfoglia per selezionare i file da caricare.
c) In the Download data to field, enter the file path that will hold extracted data.

When the process runs, it creates the following three folders in the provided file path:
• Success: Contains the extracted data in the specified format (CSV or JSON).
• Invalid: Holds documents marked invalid.
• Failed: Holds documents that could not be processed.

You can provide an output folder path based on one of the following options:
• Opzione 1: Il percorso del dispositivo locale se hai configurato l'elaborazione e la convalida del

documento sullo stesso dispositivo.
Questa opzione viene in genere utilizzata quando si esegue il test dell'istanza di
apprendimento.

• Opzione 2: Il percorso della cartella condivisa se hai impostato la convalida distribuita su
dispositivi separati.
Questa opzione viene in genere utilizzata per le istanze di apprendimento pubblicate. Ad
esempio \\10.239.192.60\Sharepath\Output.

d) Fai clic su Elabora documenti.
The Bot Runner window appears. The window disappears when the documents are done
processing. Refresh the Learning instances table to see the updated metrics.

If there is a value next to the Validate documents link, you must manually validate the document fields.
Otherwise, proceed to step 3.
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2. Fix the validation errors
a) Fai clic su Convalida documenti.

The AARI Task Manager opens in a new tab, with the first failed document in queue. For an
introduction to the Validator user interface, see Using the AARI Task Manager Validator for Document
Automation on page 2593.

b) Review each field to verify the data type and extracted value.
Document Automation supports the following data types: text, number, time, and check box
Alternatively, from the drop-down list on the right panel, you can select Show fields that need
validation.

Note:  When documents are awaiting validation, if you edit the learning instance, click
Reprocess to reattempt extraction.
Reprocessing documents does not affect the uploaded documents metric.

c) Update the fields with errors.
Click the field or draw a box around the values that you want to extract.
For Automation Anywhere pre-trained models, you can configure the learning instance to extract
specific values in a field and ignore others. Per ulteriori informazioni, consulta Using validation
feedback to extract specific values in a table on page 2573.

• To skip a document without correcting errors, click Skip to proceed to the next document in
the validation queue.

• Per rimuovere un documento che non può essere elaborato, fai clic su Contrassegna come
Non valido.

d) After you make the necessary corrections, click Submit so that the document can finish
processing.
The next document in queue appears. When all the documents are corrected, the system displays
a message stating that no more tasks are available.

e) Chiudi la scheda per tornare alla pagina Istanze di apprendimento.

3. Verificare i risultati dell'output:
a) Open the file in the Success folder that contains the extracted data and review the results to

ensure that it matches your use case.
b) Optional: Review the Learning Instance dashboard.

The dashboard displays the total number of uploaded documents and the number of documents
pending validation.

If the learning instance repeatedly cannot find a field or if characters are not correctly recognized (such as
the letter "l" extracted as the number "1"), you can try changing the OCR to Google Vision OCR.
Build a bot that uploads documents from a source folder to the learning instance. Then, publish the
learning instance assets (process, form, and bots) to the public repository so that the learning instance
can be used in public mode to extract data from real documents, and validators can manually validate
documents: Publish the learning instance on page 2586
Related concepts
Estrazione dei dati dalle caselle di controllo on page 2585
Document Automation supports check box extraction for connected learning instances. L'output varia a
seconda del formato di dati selezionato.
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Change output format from CSV to JSON
Data from successfully processed documents is available as a CSV file, by default. Change the output
format by editing the download data action before you begin uploading documents.
If you have not done so already, Creare un'istanza di apprendimento in Document Automation on page 2567.
To change the output format to JSON, perform the following steps:
1. Navigate to Automation > Private tab > Document Workspace and click the folder with the

same name as the learning instance to configure the assets.
2. Open the process.
You must update the output format for DownloadBot-ValidationSuccess and DownloadBot-
Success:
3. Click DownloadBot-ValidationSuccess and locate the DocumentType field.
4. Change OUTPUT_CSV to OUTPUT_JSON.
5. Repeat steps 3 and 4 to change the output format for DownloadBot-Success.
6. Fai clic su Salva.

Upload documents to the learning instance: Elabora documenti in Document Automation on page 2576

Convalida della formula
Use basic arithmetic, comparative, logical, and functional operations.

Tip:  We recommended using functional operators instead of mathematical operators when validating
fields and tables for better accuracy.

When formulating an expression remember the following:
• All function names must be in capital letters.
• All formulas must result in either a true or false validation.
• Field and column names are case sensitive when used within formulas. If field is defined as Qty in

design, using qty or QTY in formula results in an invalid formula.
• For variable declaration or manipulation, ensure not to use certain keywords that are reserved for

formulating an expression, including SUM, SUB, DIV, MUL, COLSUM, IF.

Mathematical Operators

Operations Descrizione Syntax

+ Addition Field/Column_Name1 + Field/
Column_Name2

- Subtraction Field/Column_Name1 - Field/
Column_Name2

* Multiplication Field/Column_Name1 * Field/
Column_Name2

/ Divisione Field/Column_Name1 / Field/
Column_Name2
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Comparative Operators

Operations Descrizione Syntax

== Equal To [Current Field/Column Name]
== [expression comprised of
one or more field/column name
or fixed numeric values]
For example, AMOUNT ==
MUL(QUANTITY, UNIT_PRICE)

>= Greater than or Equal To [Current Field/Column Name]
>= [expression comprised of
one or more field/column name
or fixed numeric values]
For example,
TOTAL_BILL_AMOUNT >=
AMOUNT_PAID

<= Less than or Equal To [Current Field/Column Name]
<= [expression comprised of
one or more field/column name
or fixed numeric values]
For example, AMOUNT_PAID
<= TOTAL_BILL_AMOUNT

> Maggiore di [Current Field/Column Name]
> [expression comprised of one
or more field/column name or
fixed numeric values]
For example, BILL_AMOUNT >
0

< Minore di [Current Field/Column Name]
> [expression comprised of one
or more field/column name or
fixed numeric values]
For example,
DISCOUNT_PERCENTAGE <
100

!= Not Equal To [Current Field/Column Name] !
= [expression comprised of one
or more field/column name or
fixed numeric values]
For example, DEBIT_AMOUNT !
= 0
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Logical Operators

Operations Descrizione Syntax

&& And: Field/Column is valid if all
conditions are true

<Current Field/Column Name>
<operator 1> <expression
1> && <Current Field/
Column Name> <operator 2>
<expression 2>
For example,
DISCOUNT_PERCENTAGE >=
0 && DISCOUNT_PERCENTAGE
<=100

|| Or: Field/Column is valid if any
one of the given conditions is
true

<Current Field/Column Name>
<operator 1> <expression
1> || <Current Field/Column
Name> <operator 2>
<expression 2>
For example,
DISCOUNT_PERCENTAGE >= 0
|| DISCOUNT_PERCENTAGE ==
'Net'

! Not: Converts a true expression
to false and also the other way
round

!<expression>
For example, !(AGE < 18) ==>
valid when AGE is not less than
18

Functional Operators

Operations Descrizione Syntax

SOMMA Summation: gives result of
addition of one or more field/
column/fixed-number values

SUM(n1,n2,....,nN)
For example, SUM(SUB_TOTAL,
SERVICE_TAX,
EDUCATION_CESS) ==>
equivalent to SUB_TOTAL
plus SERVICE_TAX plus
EDUCATION_CESS

SUB Subtraction: gives result of
subtraction of one or more
field/column/fixed-number
values from the first specified
value

SUB(n1,n2,....,nN)
For example, SUB(SUB_TOTAL,
TOTAL_DISCOUNT,
ADJUSTMENTS) ==>
equivalent to SUB_TOTAL
minus TOTAL_DISCOUNT minus
ADJUSTMENTS
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Operations Descrizione Syntax

MUL Multiplication: gives result of
multiplication of one or more
field/column/fixed-number
values

MUL(n1,n2,....,nN)
For example,
MUL(QTY_IN_BOX,
UNIT_PRICE, SHIPPED_BOXES)
==> equivalent to
QTY_IN_BOX multiply-with
UNIT_PRICE multiply-with
SHIPPED_BOXES

DIV Division: gives result of
division of one or more field/
column/fixed-number values
from the first specified value

DIV(n1,n2,....,nN)
For example, DIV(AMOUNT,
SHIPPED_BOXES, UNIT_PRICE)
==> equivalent to AMOUNT
divide-by SHIPPED_BOXES
divide-by UNIT_PRICE

COLSUM Sum of a given Column
in a table: gives result after
evaluating given expression for
each row of specified table and
adding them all together

COLSUM("<table-name>",
"<expression to evaluate for
each row of specified table-
name>")
For example, FINAL_TOTAL
== COLSUM("LINE_ITEMS",
"MUL(QTY, UNIT_PRICE)")
Say there are 3 rows for
table LINE_ITEMS, then
FINAL_TOTAL should be equal
to MUL(QTY1, UNIT_PRICE1)
+ MUL(QTY2, UNIT_PRICE2) +
MUL(QTY3, UNIT_PRICE3)
where, QTY1 is QTY value in
row 1, similarly UNIT_PRICE1
is UNIT_PRICE value in row
2, and so on for other rows as
well.

Pattern validation
A pattern defines an acceptable format for date, number, or text fields. Reference the tables below for
common examples:

Testo

Field Pattern Notes Descrizione

E-mail ^([a-z0-9_
\.-]+)@([\da-z
\.-]+)\.([a-z\.]
{2,6})$

This regular expression
validates emails like
john@ado.com.

The Email field
supports regular
expressions.
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Field Pattern Notes Descrizione

Numero di telefono ^(\(?\+?[0-9]*
\)?)?[0-9_\-
 \(\)]*$

This regular expression
validates phone
numbers like (+64) 38
3235393.

The Phone Number
field supports regular
expressions.

Website ^([a-zA-
Z0-9]+(\.[a-zA-
Z0-9]+)+.*)$

This regular expression
validates websites like
www.domain.com.

The Website field
supports regular
expressions.

Number string ^[0-9]{1,45}$ This regular expression
validates a string with
numbers 0 - 9 and limit
length to 45.

The Number string
field supports regular
expressions.

Alpha-numeric ^[A-Za-z0-9_@./
#&amp;+-]*$

This regular
expression validates
a string containing
alphanumeric values
like INV-001.

The Alpha-numeric
field supports regular
expressions.

Numero

Field Pattern Notes Descrizione

Number string ^[0-9]{1,45}$ This regular expression
validates a string with
numbers 0 - 9 and limit
length to 45.

The Number string
field supports regular
expressions.

Connetti l'istanza di apprendimento
Connettiti a un'istanza di apprendimento in Automation 360 IQ Bot per elaborare i documenti in
quell'istanza di apprendimento usando il flusso di lavoro Document Automation.
To perform this task, you must have one of the following roles:
• AAE_IQ Bot Admin
• AAE_IQ Bot Services
• Un ruolo personalizzato con l'autorizzazione Connetti l'istanza di apprendimento

Apri gli ambienti Document Automation e Automation 360 IQ Bot sullo stesso dispositivo.
Quando connetti un'istanza di apprendimento creata in Automation 360 IQ Bot, il sistema crea le
risorse dell'istanza di apprendimento (bots RPA, processo AARI e modulo) per consentire all'istanza di
apprendimento di iniziare a elaborare i documenti in Document Automation.

Note:
• This feature is available only for Document Automation customers. It is not available in Community

Edition.
• L'ambiente Automation 360 IQ Bot deve essere associato alla Control Room dove Document Automation

è installato. Inoltre, Automation 360 IQ Bot deve disporre di una versione compatibile con la Control
Room.
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• È possibile collegare un'istanza di apprendimento alla volta.

Un'istanza di apprendimento connessa può estrarre dati dalle caselle di controllo se il dispositivo è
configurato con il pacchetto Microsoft Visual C++ 2019 Redistributable: Estrazione dei dati dalle caselle di
controllo on page 2585
1. Login to the Control Room as the Admin user. Navigate to Manage > Learning Instances. Click

Connect learning instance.
This takes you to Connect Learning Instances from IQ Bot classic page which contains a list of
Automation 360 IQ Bot learning instances.

2. Seleziona l'istanza di apprendimento dalla versione Automation 360 IQ
Bot con cui connetterti. Move it from left to right. Fai clic su Connetti.

The newly-connected learning instance appears in the Learning instances table in private mode.

Note:  Il valore nella colonna Provider indica se un'istanza di apprendimento è stata connessa da
Automation 360 IQ Bot o creata in Document Automation.
• Per un'istanza di apprendimento connessa, il valore della colonna Provider è Formato dall'utente.
• Per un'istanza di apprendimento creata in Document Automation, il valore della colonna Provider è

Automation Anywhere(Preformato).

Note:  È necessario mantenere il server Automation 360 IQ Bot perché memorizza la configurazione e i
dati di formazione dell'istanza di apprendimento connessa.

• Un'istanza di apprendimento connessa può essere modificata solo in Automation 360 IQ Bot. Per
modificare l'istanza di apprendimento dopo averla connessa, fai clic sul nome nella tabella Istanze di
apprendimento e verrai reindirizzato all'apertura dell'istanza di apprendimento in Automation 360 IQ Bot
in una nuova finestra.

• Per caricare i documenti da elaborare, fai clic su Elabora documenti. Elabora documenti in Document
Automation on page 2576

Estrazione dei dati dalle caselle di controllo
Document Automation supports check box extraction for connected learning instances. L'output varia a
seconda del formato di dati selezionato.
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Una casella di controllo è un oggetto dell'interfaccia utente che consente di effettuare una scelta binaria:
seleziona o lascia deselezionato. Document Automation supporta l'estrazione di dati da caselle di controllo
o pulsanti di opzione contrassegnati da un segno di spunta, una croce o un punto. Oltre alle caselle di
controllo quadrate e ai pulsanti di opzione rotondi, Document Automation supporta i contorni a triangolo e
a rombo.
Document Automation supporta l'estrazione di caselle di controllo di gruppo da istanze di apprendimento
connesse. Per ulteriori informazioni sui gruppi di caselle di controllo, vedi Estrazione dei dati dai gruppi di
caselle di controllo in Automation 360 IQ Bot.

Note:  Per abilitare il rilevamento delle caselle di controllo, è necessario installare il pacchetto Microsoft
Visual C++ 2019 Redistributable sul dispositivo Bot Runner in cui vengono elaborati i documenti.Download
Microsoft Visual C++ Redistributable

Come vengono generati i dati

I valori di output possibili sono Yes, No o No Checkbox Found. Il formato di output dipende dal formato
selezionato Change output format from CSV to JSON on page 2580.

Note:  Indipendentemente dalla lingua del documento, i valori di output sono sempre in inglese.

Publish the learning instance
Check-in the process associated with the learning instance. Then, build a bot that uploads documents from
a source folder to the learning instance and check it in to the public repository. Finally, deploy the process
and bots to unattended Bot Runner devices to begin processing documents in real time.
For Bot Runner devices with a Windows 2012 server-based operating system:
1. Download and install the Windows Essential Media Pack from Microsoft.
2. Install the Media Foundation feature from the Windows Server Manager.

1. Publish the process.
a) Navigate to Automation > Private tab > Bots > Document Workspace processes and

select the folder with the same name as the learning instance.
b) Mouse over the vertical ellipses to the right of the process to open the actions menu and click

Check in process.
The Check in Process window opens with the bots and form auto-selected to also be checked
in.

c) In the Check in Process window, add your comment and click Check in.
The process appears in the same folder structure in the public workspace.

See these steps in a video:

2. Build the Extraction-Scheduler bot to automate uploading documents to the learning instance:
Build a bot to upload documents to Document Automation on page 2587

© 2023 Automation Anywhere. All rights reserved.     2586

https://docs.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-160#visual-studio-2015-2017-2019-and-2022
https://docs.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-160#visual-studio-2015-2017-2019-and-2022


    Automation Anywhere - Digitalizzazione

3. Publish the Extraction-Scheduler bot.
a) Locate the Extraction-Scheduler bot in the private tab.
b) Mouse over the triple ellipses to the right of the bot to open the menu and click Check in Task

bot.
The Check in Task bot page opens with the bot auto-selected.

c) Add a comment and click Check in.

4. Login as the Document Automation Admin user to deploy the process and bots to unattended Bot
Runner devices: Deploy the learning instance assets on page 2592

Once the process and Extraction-Scheduler bot are deployed, documents in the specified folder are
uploaded to Document Automation, and Document Automation either extracts data from the documents or
sends the documents for validation.
Navigate to Activity > In progress to see the status of the running bots.

Build a bot to upload documents to Document Automation
Build a bot to upload documents to a specific learning instance for processing and extraction.
• Ensure you have the name of the destination learning instance.
• If you have an adequate amount of Bot Runners connected. For instructions on connecting a Bot

Runner, see step 5 of Set up your Document Automation environment on page 2562.

Note:  You need a dedicated Bot Runner for this bot and additional Bot Runners for the extraction
and download bots, depending on the average number of pages in the documents. Review the
explanation below for more guidance on how many Bot Runners are needed.

• Decide on the scheduling interval for deploying this bot with a maximum interval of every thirty
minutes.

• Determine the average number of pages in the documents awaiting upload.

This bot is necessary for end-to-end automation of the document extraction process. When deployed,
the bot checks if there are enough Bot Runners to handle the documents, by comparing the number of
files already uploaded against a calculated value. The calculation considers the number of Bot Runners,
scheduling interval, and average number of pages in the documents.

Note:  This step is important as it controls the number of documents being uploaded to ensure smooth
processing and avoid overloading the Bot Runners, which might cause a time-out error.

To determine the number of Bot Runners needed, consider the following:
• One Bot Runner can process a single-page document in one minute.
• One Bot Runner can process a two-page documents in two minutes.
• One Bot Runner can process 1440 single-page documents in one day.
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• Two Bot Runners can process two single-page documents in one minute.

Use this equation to determine how many Bot Runners are needed:

Number of Documents to Process per day * Average Number of Pages per
 document / 1440 = Number of Bot Runners

Note:  If the equation result is not an integer, you must round up to the next whole number to obtain an
adequate number of Bot Runners. For example, if the equation result is 4.2, you will need 5 Bot Runners.

As an example, if you want to process 10,000 documents each day with an average of one page per
document, you need seven Bot Runners:

10,000 documents * 1 page per document / 1440 = 7 Bot Runners

To build the bot, follow these steps:
1. Navigate to Automation > Private tab and click Create a bot.

Ensure you do not place the bot in the Document Workspace folder.
2. Provide a name for the bot, such as Extraction-Scheduler.
3. Create the following variables: Create a variable on page 2030

Variable name Descrizione Tipo di dati Valore

File_Count Increments with
each loop iteration
to count the number
of files uploaded for
processing.

Numero 0

Extraction_DeviceCountNumber of Bot
Runner devices
connected to the
Control Room

Numero Enter the number
of connected Bot
Runner devices

Scheduler_IntervalScheduling interval in
minutes

Numero Enter the interval
for which you will
schedule this bot
to run when you
deploy it (minimum
2 min,maximum 30
min)

Average_Pages Average number of
pages per document

Enter the
approximate average
number of pages in
the documents

FilesInFolder Holds file name and
extension

Dizionario --

SourcePath File path to the
folder containing
documents awaiting
upload to Document
Automation

Stringa Enter the file path
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Variable name Descrizione Tipo di dati Valore

OutputPath File path to the
folder containing
the extracted data
and invalid or failed
documents

Stringa Enter the file path
where you want the
extraction output

4. Insert a Loop action to iterate through all the documents in a specific file path.
a) Fai doppio clic o trascina l'action Loop.
b) Select the For each file in folder iterator.
c) Insert the SourcePath variable into the Folder path field.
d) Insert the FilesInFolder variable into the Assign file name and extension to this

variable field.

5. Insert an If action to compare the number of documents uploaded for processing to the number of
Bot Runner devices multiplied by a scheduling interval and divided by the average number of pages.

Note:  You must include this equation to limit the number of files uploaded for processing at one time
to ensure that the Bot Runners are able to process the documents.

a) Drag the If action into the Loop container.
b) Select the Number condition.
c) Insert the File_Count variable into the Source value field.
d) Select the Less than operator.
e) Enter the following into the Target value field: $Extraction_DeviceCount$*

$Scheduler_Interval$/$Average_Pages$

6. Insert If: Else and Loop: Break actions to end the loop if the condition is not met:
a) Drag the If: Else action beside the If action in the Loop container.
b) Drag the Loop: Break action into the If: Else container.

7. Insert an error handling mechanism to log any possible errors:
a) Drag the Error handler: Try action into the If container.
b) Drag the Error handler: Catch action beside the Error handler: Try action.
c) Drag a Delay action below the Error handler: Catch action.
d) Set a delay of 10 seconds.
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8. Configure actions to upload documents to the process associated with a specific learning instance.
a) Drag the AARI Web: Create a request action below the Error handler: Try action.
b) Mark the Set LearningInstanceName option and provide the name of the learning instance

where to send the documents.
c) Mark the Set InputFile option and enter $SourcePath$/$FilesInFolder{name}$.

$FilesInFolder{extension}$.
d) Mark the Set InputFileName option and enter $FilesInFolder{name}$.

$FilesInFolder{extension}$.
e) Mark the Set OutputFolder option and enter $OutputPath$.
f) Drag the Number: Increment action below the AARI Web: Create a request action.
g) Insert the File_Count variable into the Number and Assign output to variable fields.

The Number action increases the value of File_Count by one each time a file is uploaded to
the learning instance. As long as the value in File_Count is less than the total in the equation
you entered in step 5, the bot can run another loop iteration to upload another document to the
learning instance.

9. Make a copy of the uploaded file to a different location on your desktop to keep track of which
documents were successfully uploaded:
a) Drag the File: Copy Desktop file action below the Number: Increment action.
b) Enter $SourcePath$/$FilesInFolder{name}$.$FilesInFolder{extension}$ in the

Source file field.
c) Provide the folder path where to copy the files.

10. Remove documents after they are uploaded to Document Automation so they do not get re-uploaded
in the next iteration:
a) Drag the File: Delete action.
b) Enter $SourcePath$/$FilesInFolder{name}$.$FilesInFolder{extension}$ in the

File field.

11. Fai clic su Salva.

The completed bot should resemble the one in the image below:
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Publish the process and bot. See step 3 of Publish the learning instance on page 2586
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Deploy the learning instance assets
Deploy the process and RPA bots to the unattended Bot Runner devices, and assign the learning instance
to a validation team. Here, you configure the learning instance assets to process documents in real time.
• The user who created the learning instance assets must check-in the process, form, and bots to the

public repository. If you have not done so already, complete steps 1 and 2 of Publish the learning instance
on page 2586.

• To deploy the learning instance assets, you must be an Admin user. Consulta Document Automation utenti
on page 2564.

1. Assign the a team of Validators to the process:.
a) Open AARI by appending /aari to the Control Room URL.
b) Navigate to Manage > Process and locate the process with the same name as the learning

instance.
c) Click the process to assign it to a team.
d) Navigate to the Request Creation section and select the by Bot option.
e) Navigate to the Teams tab and click the Add icon on the left side.
f) Select the team and click Add and save.
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2. Deploy the Extraction-Scheduler bot
See these steps in a video:
a) Return to the Control Room by removing /aari from the Control Room URL.
b) Navigate to Automation > Public tab and locate the Extraction-Scheduler bot.
c) Follow the steps to Programmare un bot on page 2616.

• At the scheduling details section, select Run repeatedly.
• Select the Repeat every option to schedule the bot on a recurring basis.

When you provide the desired interval and frequency, ensure that the interval matches the
value in the Scheduler_Interval variable in the Extraction-Scheduler bot.

Note:  If you are scheduling the bot to run starting today, you must repeat the steps two
times to schedule the bot as follows:
• Schedule the bot with the desired start time for today, with an end time of 11:59pm on the

same day.
• Schedule the bot to start tomorrow at 12:00am, with an end time of 11:59 on a future

date.

Important:  If you do not follow this guidance, the bot will start running each day at the
time you provided in the Start time field, instead of being scheduled to run for 24 hours of
each day.

• When selecting a Bot Runner, deploy the Extraction-Scheduler bot to a different Bot
Runner than the one running the process.

Note:  A Bot Runner can run only one bot at a time. Ensure that you use separate Bot
Runners for the process and the Extraction-Scheduler bot, so that the Extraction-
Scheduler bot does not interfere with the Extraction and Download bots.

Once the process and Extraction-Scheduler bot are deployed, documents in the specified folder are
uploaded to Document Automation, and Document Automation either extracts data from the documents or
sends the documents for validation.
Navigate to Activity > In progress to see the status of the running bots.

Using the AARI Task Manager Validator for Document Automation
Document Automation uses Automation Anywhere Robotic Interface technology to manage the end-to-
end document extraction process. Each incoming document creates a new request, which triggers the
extraction process. If a document requires manual validation, AARI creates a validation task and assigns it
to a validation team.
When you click the Validate documents link in the Learning instances page, the AARI Task Manager
opens in a new tab, with the first failed document in queue.

Note:  An empty page with a notification message appears in the following scenarios:
• If you are not assigned to any validation teams, and thus do not have access to learning instances.
• If there are no files that require validation in the learning instances to which you have access.
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• Se un altro utente sta lavorando con il file rimanente nella coda di convalida.
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1. You can toggle between the Table and
Detail views

Detail view: We recommend that you perform
validation tasks in the Detail view because this
view shows all the documents in the validation
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queue side by side with the document that you
are currently validating. Inoltre, al termine della
convalida di un documento, viene automaticamente
aperto il documento successivo in coda.

Note:  You can search for specific documents
(tasks) in Detail view only.

Table view: Use the Table view see learning
instance history. When you open a document from
this view, the history for the learning instance that
is processing this document appears in a pane on
the left. Click the empty text field, then select the
blue-bounded box in the document that contains
the data to extract. After you select a box, the data
is highlighted in yellow and a green outline appears,
which you can resize or reposition to include all the
data that you want to extract.

2. Filter the documents in your queue The Validator opens with certain filters enabled by
default to show only the documents from a specific
learning instance that need validation.

3. Your documents queue The documents that match the parameters you
specified in the filters pane appear here.
You can switch between documents in the queue
without completing validation for the current
document.

4. Customize your view Use the icons in the taskbar to hide the blue-
bounded system identified regions, stack the
document pane above the fields pane, or change
the zoom levels.

5. Toggle between the fields views Use the drop-down list to select between Show
all fields to see all the document fields or Show
fields that need validation to only show the
fields that need your manual validation.

6. Fields awaiting validation are outlined in
red

In the example above, the table fields Item total
and Quantity require manual entry.

7. Add or delete a row To insert or delete a row, hover over the ellipses to
show the icons for adding or deleting table rows.

8. Skip to next file Skip a file without correcting the errors in the
current document.

9. Rielabora If the learning instance is edited while documents
are awaiting validation, you must Reprocess the
documents.

10. Contrassegnare un documento come non
valido

Removes the document from the validation queue
and saves a copy of the document to the Invalid
folder. Click here to mark a document as invalid,
then select from the following reasons:
• Campi mancanti
• Tabelle mancanti
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• Valori errati

For documents processed in a connected
learning instance:

The Validator shows the group number for the
document. If you are unsatisfied with the extraction
results, you can retrain the learning instance in
Automation 360 IQ Bot.

Convalidare i documenti in Document Automation
If a learning instance cannot extract data from a document (for example, blurry text, data does not match
data type, or data is missing for a required field), it sends that document to the validation queue, where
the Validator user manually provides the data.
The learning instance assets must be checked-in to the public repository.
The Validator is comprised of two panels with the document on the left side and the fields with extracted
data on the right side.
In a window that is 1280 pixels or more, the panels are positioned side-by-side. Otherwise, the panel
containing the fields and extracted data shifts below the panel containing the document, as demonstrated
in this video:

Note:  If a document contains tables with large number of rows or data fields (>1000), there might be a
delay in the initial validation and the corresponding response time.

1. Log in as the Validator user.
2. From the Control Room home page, navigate to Manage > Learning Instances.

The Learning instances table displays details for each instance. The value in the Validate
documents link indicates the number of documents awaiting manual validation.

3. Fai clic su Convalida documenti.
The AARI Task Manager opens in a new tab, with the first failed document in queue. For an
introduction to the Validator user interface, see Using the AARI Task Manager Validator for Document
Automation on page 2593.

4. Provide correct values to the fields that need validation.
See these steps in a video:

a) Select Show fields that need validation from the drop-down list in the right panel.
b) Click the field to extract.
c) In the document image, click the blue-bounded box containing the correct data or draw a box

around the data you want to extract.
• Per ignorare un documento senza correggerne gli errori, fai clic su Ignora per passare al

documento successivo nella coda di convalida.
• Per rimuovere un documento che non può essere elaborato, fai clic su Contrassegna come

Non valido.

5. After you make the necessary corrections, click Submit so the document can be processed and the
extracted data downloaded.
The extracted values are saved to a file in the Success folder. Validator mostra il documento successivo
in coda. When all documents are corrected, the system displays a message stating that there are no
more tasks available.
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Export/Import learning instances
A user with the IQ Bot Admin role or with the View and manage migration permission can use the
Export and Import buttons to move learning instances between Document Automation environments.

Export a learning instance

When you export a learning instance, a .dw file is downloaded to your desktop with the learning instance
configurations, including the language, provider, and fields.
To export a learning instance, navigate to Manage > Learning Instances and mouse over the vertical
ellipses to the right of the learning instance you want to export. Then, click Export.

Note:  The process and bots associated with the learning instance are exported separately: Export an AARI
process on page 2152 | Esporta bots on page 2835

Import a learning instance

First, import the process and bots associated with the learning instance: Importazione di un processo AARI on
page 2150. If you do not import the process, Document Automation will create a new process when you
import the learning instance.

Note:  Verify that the destination environment has the necessary licenses. Consulta Licenze Automation 360
on page 1010.

To import a learning instance:
1. Navigate to Manage > Learning Instances and click Import at the top of the page.
2. Click Browse to select the learning instance.

Note:  If there is already a learning instance in this environment with the same ID number, the
imported learning instance overwrites the existing one.

3. Select whether to pair the learning instance with an existing process or to create a new process.

Using Document Automation for Standard Forms
Standard Forms are fixed format type documents that have a defined template, with little or no variation
in the overall layout, and are typically official or legal forms, such as a W-4 (Employee Withholding
Certificate) form, income tax form, or a sale deed.

See the following video on how Microsoft Standard Forms integrates with Document Automation and its
enhanced processing capabilities.

With enhanced accuracy, this feature enables you to extract data from densely structured forms including
those with handwritten input in more than 200 languages. For more information on the supported
languages for text and field extraction and detection, see Language support for Form Recognizer.
The following overview provides an end-to-end process you can use to create the Standard Forms
data model, configure the learning instance, and publish the learning instance to process documents
autonomously, all within the Document Automation interface.
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Note:  Set up your Document Automation environment, which includes configuring users, roles, and
devices, and connecting the Control Room with the Automation Anywhere Robotic Interface: Set up your
Document Automation environment on page 2562.

1. Evaluate your use case for Standard Forms.
Evaluate your use case on page 2599

2. Review extraction service.
Rivedi il servizio di estrazione

3. Set up and configure an extraction service.
Configura il servizio di estrazione on page 2602

4. Configure Document Automation for the selected extraction service.
Configure Document Automation with Microsoft Azure Form Recognizer on page 2602

5. Build a data extraction model.
Create standard form in Document Automation on page 2603

6. Create a learning instance with the Standard Forms data model.
Create a learning instance for standard forms on page 2605

7. Carica i documenti nell'istanza di apprendimento per testare il modello, correggi gli errori di convalida
e verifica i dati estratti.
Elaborare i documenti

8. Costruisci un bot che carica i documenti da una cartella sorgente a Document Automation.
Build a bot to upload documents to Document Automation on page 2587

9. Transfer the Standard Forms learning instance across different Document Automation environments.
Transfer standard forms learning instance on page 2607

10. Check the learning instance assets (process, form, and bots) into the public repository. Then, deploy
the process and bots to unattended Bot Runner devices to begin processing documents in real time.
Publish the learning instance on page 2586

11. Validate the processed documents for the Standard Forms learning instance.
Convalidare i documenti caricati

Evaluate your use case
Before processing documents in Document Automation, you must ensure that your documents are
Standard Forms. After you confirm that your document meets the prescribed Standard Forms criteria, you
can proceed with the type of extraction service required.
To determine if your use case meets the Standard Forms criteria, review the following parameters:
• The layout of your document remains the same across vendors.
• The positions of various data elements such as checkboxes, tables, and so on, is fixed in your

documents.
• You have documents where the values are independent of other data elements.
• Your document is available in a supported language. Per ulteriori informazioni, consulta Azure Form

Recognizer Supported Languages.
• Your document must have un-repetitive sections. In other cases, there must be a fixed number of such

repetitive sections that do not vary between documents.
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• Your documents contain tables that have the same number of rows and columns.
• The document layout remains the same within the same year, across different organizations.

Rivedi il servizio di estrazione

After you have confirmed that the documents are Standard Forms, you can then plan the type of standard
forms extraction service that fits your requirement. You can use the Microsoft Form Recognizer service to
process Standard Forms in Document Automation. Before processing, ensure the following:
• Input documents can contain:

• Information with many details and have a reasonable quality resolution (>200 dpi)
• Check-boxes and radio buttons
• Handwritten content
• Signatures
• Tabelle

Note:  Input documents can also contain tables that span over a single page. However, if the
Standard Forms contain table that spans across multiple pages, the content extraction can fail.

• No section of the input document is repeated.
• Documents that contain transpose tables.

Benefits of Microsoft Azure Forms Recognizer service

• Ability to process diverse standard form type documents.
• Auto detection feature can identify different types of tables, such as header-less tables, inverted tables,

and so on.
• Provides good support for handwritten forms.

Data Flow for Standard Forms in Document Automation
The following data flow diagram shows how to configure Standard Forms in Document Automation using
various components that facilitate the flow of data between Document Automation and the third-party
extraction service.
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• Labeling and model creation tool
You use the model creation tool to label and create models. In this diagram, the training documents are
uploaded in the tool and stored in the blob storage of the third-party service. To obtain the best results,
we recommend that you upload and label a minimum of five training documents to create a model.

• Blob storage
Blob storage is a storage unit that contains training documents and its related information.

• Extraction model
The trained models stored in the blob storage of the third-party service are fetched through APIs. The
Model ID, which can be a GUI ID or a standard name, is used to create the learning instance.

• Learning instance creation
You can browse and select the model to create a Learning instance. After you select the model, you can
upload a document for extraction to this Learning instance. The Learning instance accesses the third-
party extraction service to retrieve extraction results. The results either move to the output folder, or
the document moves to the validator.

• Extraction engine
The extraction engine performs extraction based on the model ID and returns the results to the
Learning instance.
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• Output results
Once the extraction is completed, the output results will include three components:
• extraction .csv
• auto detected table .csv
• response.json

Configura il servizio di estrazione
To extract content from Standard Forms, you must setup and configure Microsoft Azure Form Recognizer
service.
Document Automation provides you with the option to get your own license key or purchase license from
Automation Anywhere. For more information on licenses, see Licenze Automation 360 on page 1010.
1. Subscribe to Microsoft Azure service

Microsoft provides the Azure Form Recognizer service. Questo servizio consente di creare un
software di elaborazione dati automatizzato in grado di identificare ed estrarre contenuti specifici dai
documenti. You must have Microsoft Azure subscription in order to access Azure resources (OCR,
Form Recognizer), Automation Anywhere provides access to these resources through its subscription.
Contact your Customer Success Manager (CSM) or Partner Enablement Manager (PEM) who will help
you setup the services.
Request access for Microsoft Azure resources (OCR and Form Recognizer) (A-People login required)

2. Setup Microsoft Azure Form Recognizer service
For Cloud deployment
• If you purchase the license from Automation Anywhere, no additional configurations or changes are

required.
• If you purchase the license from Microsoft Azure, review the following article to setup and

configure your Microsoft Azure Form Recognizer for extracting content from standard forms.
Setup Azure Form Recognizer and Storage (Cloud) (A-People login required)

Next steps

Connect Document Automation with the extraction service. See, Configure Document Automation with
Microsoft Azure Form Recognizer on page 2602.

Configure Document Automation with Microsoft Azure Form Recognizer
Send an API request to connect Document Automation with the extraction service.

Note:  You will need the following information:
• Authorization token. Vedi Authentication API
• Microsoft Azure Form Recognizer endpoint
• Microsoft Azure Form Recognizer API key
• Microsoft Azure Blob storage URI

© 2023 Automation Anywhere. All rights reserved.     2602

https://apeople.automationanywhere.com/s/article/How-to-request-access-for-Azure-resources-OCR-Form-Recognizer
https://apeople.automationanywhere.com/s/article/Setup-Azure-Form-Recognizer-and-Storage
auth-api-supported.html


    Automation Anywhere - Digitalizzazione

For Document Automation Cloud:

Richiesta

PUT <Cloud Host Url>/cognitive/v3/formrecognizer/config

Headers: X-Authorization - <IQBot Admin User Auth token >

Corpo della richiesta:

{    "formRecognizerApi": <Cognitive Service
 Endpoint>,    "formRecognizerKey": <Cognitive Service
 apiKey>,    "blobStorageSas": <Azure blob storage SAS Uri> 
 }

}

For Document Automation on-prem:

Richiesta

PUT <On-Prem Machine ip> / localhost/cognitive/v3/formrecognizer/config

Headers: X-Authorization - <IQBot Admin User Auth token >

Corpo della richiesta:

{    "formRecognizerApi": <Cognitive Service
 Endpoint>,    "formRecognizerKey": <Cognitive Service
 apiKey>,    "blobStorageSas": <Azure blob storage SAS Uri> 
 }

Note:  The parameters are provided by the CloudOps team.

Next steps

Log in as the Learning instance creator user to Create standard form in Document Automation on
page 2603.

Create standard form in Document Automation
Create a Standard Forms extraction model in the Control Room.
• Ensure your Control Room has the Document Automation Standard Forms (Number of pages) product

license
• You must have the AAE_IQ Bot Admin or AAE_IQ Bot Services roles to complete this task
• Identify between five and fifteen training documents

1. In the Control Room, navigate to Manage > Learning Instances and click Create model.
The Projects window opens in a new tab.

2. Click Create project.
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3. Enter a name for the project, click Browse to upload documents to train the extraction model, and
click Create.

4. Define the field tags:
a) Click Add new tag.

b) Enter a name for the tag. For example, Invoice no. or Invoice Date.

5. Define the table tags:
a) Click Configure table tag.

b) Enter a name for the table.
c) For each column in the table, enter the name of the column under the Column fields section.

d) When you are done entering the columns names, click Save.

6. Define the location of the data for each field:
a) For the form fields, highlight the location of the data to extract, then click the respective field in

the right panel.

b) For each row in the table, highlight the location of the data to extract, then click the respective
table field on the right.

c) Click Done, then open the next document and repeat the steps to define the locations of the
form and table fields.
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7. Click the Train model icon, enter a name for the model, and click Train.

8. Click the Analyze icon, click Browse for file, and select a document to test the extraction model.

Next, Create a learning instance for standard forms on page 2605

Note:  You cannot edit an extraction model after associating it with a learning instance.

Create a learning instance for standard forms
Un'istanza di apprendimento è una struttura che contiene informazioni come il tipo di documento, la lingua
e i campi da estrarre. After creating Standard Forms, you must create learning instance to extract data
from the documents.
• Ensure your Standard Forms configuration is complete.
• Ensure your Control Room has the Document Automation Standard Forms (Number of pages) product

license

1. From the Control Room home page, navigate to Manage > Learning Instances > Create
Learning Instance.

The Create Learning Instance window opens in a new tab.
2. Add a name for the new learning instance to be created.
3. From the Document Type drop-down menu, select Standard Forms.

Note:  The provider name is selected as Microsoft Form Recognizer by default.

4. For model selection, click Browse and search for a model using name or description filter.
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5. Select your model and click Next.
6. To proceed further, you must select atleast one field:

• Tabella
• Moduli

Note:  Standard forms support multiple tables. However, Document Automation does not allow
displaying multiple tables. Hence, the tables are displayed as tablename:field name under Tables
tab.

7. Some other field attributes are as follows:
Opzione Descrizione

Nome campo Immetti un nome di un campo che inizi con un carattere alfabetico
(A-Z o a-z).
In standard fields, the field name is hardcoded and cannot be
changed.

Etichetta del campo Immetti un nome intuitivo per aiutare i validator.
Ad esempio, è possibile rinominare il Codice fiscale
dell'organizzazione con un nome localizzato, ad esempio
Partita IVA.
The field label does not affect extraction.

Attendibilità Imposta una soglia per ridurre i potenziali falsi positivi.
At the time of processing, the Document Automation engine
assigns a score to each field in a document to indicate the
certainty that the data was correctly extracted. Se il documento
contiene campi con un punteggio inferiore alla soglia di
confidenza, il documento viene inviato alla coda di convalida.
If you enter a high confidence threshold, more documents will
be sent to the validation queue. If you enter a low confidence
threshold, fewer documents will be sent to the validation queue.
Supports values from zero to 100.

Tipo di dati Choose from Address*, Text, Number, and Date.
If the data in the field does not match the data type, the
document is sent to the validation queue.
Document Automation supports variations of the date format.

Note:  If you are configuring a learning instance with a user-
defined document type, the form fields include the address data
type, which extracts the entire structure of an address.
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Opzione Descrizione

Obbligatorie Seleziona una delle seguenti:
• Required: Field cannot be empty.
• Facoltativo: Field can be empty or not exist in the document.

Validation rules Depending on data type, create rules using patterns, formulas,
lists, and statements such as starts or ends with.
Inizia con e Termina con on page 2513 | Modello on page 2513 |
Elenchi on page 2518 | Formule on page 2518

8. Fai clic su Crea.

When a new learning instance is created, the Control Room creates a folder with the
same name as the learning instance in the Automation > Document Workspace
folder. The folder contains two bots (extraction and download), a process, and a

form.
• Process: Gestisce il processo utilizzando scenari IF/Else attraverso i quali Document Automation estrae

i dati dai documenti caricati, assegna i documenti agli utenti per la convalida e scarica i dati estratti. To
learn more, see About the AARI process in Document Automation on page 2574

• Extraction bot: Extracts data from defined fields in the uploaded documents.
• Download bot: Consente di scaricare i dati estratti in una cartella specifica sulla periferica o sulla rete

condivisa.
• Form: Defines the input parameters that are sent to the process. I parametri di input includono il nome

dell'istanza di apprendimento, il file caricato e il percorso del file di output.

Upload documents to the learning instance, fix validation errors, and verify the extracted data: Process
documents in Document Automation

Transfer standard forms learning instance
Standard forms learning instance can be used across similar Document Automation environments. Export/
Import an existing learning instance to avoid creating another one with the same configurations.
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• Ensure that the source and destination systems are running the same Document Automation version.
Learning instances from different Document Automation versions cannot be imported because their
database schema will not match.

• Back up your database before importing learning instances.
• Export the .dw file from the source Document Automation environment.
• Import the .dw file into the destination Document Automation environment.
•

Note:  The incoming model of the source system must be available in the configuration of the target
system.

For detailed information on exporting/importing learning instances, see Export/Import learning instances on
page 2598.
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Gestisci
As a Control Room administrator, create users and roles, and configure devices that access Automation
360. From the Control Room, you can also monitor and manage all activities to ensure a secure and
seamless bot execution environment for your users.

Activity and audit log

Monitor and manage automations, such as bot execution, scheduled and event trigger activities using the
Activity console (Activity from the left menu). You can also review and troubleshoot any failed activities
using the Audit log console (Administration > Audit log).
See the following pages for more information:
• Cronologia attività alla pagina 2613
• Scheduled activities alla pagina 2616
• Trigger di evento alla pagina 2624
• Log di audit alla pagina 2654

The following short video shows how to check your bot runs:

Users, roles, and permissions

You can configure users and roles (role-based access control or RBAC) to provide access to specific
features and operations, based on their assigned roles. Creating users depends on whether the user is a
non-Active Directory, Active Directory, or single sign-on (SSO) user from an IdP server.
• Utenti alla pagina 2683
• Ruoli alla pagina 2693

• Autorizzazioni per le funzioni di un ruolo alla pagina 2694
• Bot permissions for a role alla pagina 2706

• Credentials and lockers in the Credential Vault alla pagina 2839

Devices and queues

A device is the machine through which a user connects to the Control Room to create or run bots. Manage
devices that are registered to the Control Room from Manage > Devices.
A queue is a logical group of Work Items that are processed for automation by the Bot Runners from a
pool based on priority selected in the device pool and sort criteria configured in the queue.
• Dispositivi alla pagina 2628
• Gestione del carico di lavoro alla pagina 2797
• Device pools
• Add queue, Bot Runner, and device pool alla pagina 2810
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Impostazioni

After initial setup of the Control Room, you (as an administrator) might have to set up and edit some of
the initial configurations to enable certain features. Go to Administration > Settings to configure and
edit settings for bots, packages, devices, email, network, user authentication, security, Git repository,
external key vault and so on.
The following image shows some of these

settings:
Consulta Impostazioni alla pagina 2721.

Vedi anche

See the following pages for information on other features and settings:
• Bot Lifecycle Management alla pagina 2832
• Analisi del codice alla pagina 2782
• CoE Manager alla pagina 2926
• Bot Store alla pagina 2944

© 2023 Automation Anywhere. All rights reserved.     2610



    Automation Anywhere - Gestisci

Attività correlate
Programmare un bot alla pagina 2616
Programma un bot da eseguire a un'ora specifica.
Set up locker and assign credentials alla pagina 2841
Create a role, credentials, and locker to share related sensitive values with a group of users, so they can
use those values to build or run bots.
Create a role alla pagina 2693
As an administrator, you can configure roles with permissions to access features and perform operations
such as create, edit, or delete a bot in the Control Room, and assign the role to a user.
Create a user alla pagina 2684
Crea un utente e assegna il suo ruolo specifico basato su licenza.
Set user device credentials alla pagina 1052
Per abilitare un dispositivo per l'esecuzione di bots, imposta le credenziali del dispositivo locale.
Modifica profilo alla pagina 1002
Manage user profiles.
Installazione di licenze aggiuntive alla pagina 2794
Carica le nuove licenze in Automation Anywhere Control Room da distribuire agli utenti come richiesto.

Attività
Monitor all ongoing automations and pause, stop, and resume them as required. Also, view the Bot Runner
(attended or unattended) trigger deployments in queue.

In-progress activity

Depending on the permissions granted by administrators, as a user, you can view and manage bots and
bot folders. With specific permissions, you can perform the following:

View everyone's activity from my folders With run or schedule permissions on folders, you
can view all bot activity started by other users from
those folders. This will be a super set in the View
my activity output.

Manage everyone's activity from my folders With run or schedule permissions on folders,
you can perform management activities, such as
Pause, Resume, and Stop on all bot activity
started by various users from those folders.

Based on the administrative permissions, you can apply various search parameters to monitor and find the
required in-progress activities.
The following table describes various search parameters, their description, and possible values or examples
to search the in-progress activities:
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Parametro Descrizione Possible values and examples

Status Search for an activity based on
its status.

• Started
• Active
• Paused
• Unknown
• Paused for input
• Pending execution
• Queued

Automation priority Search for an activity based
on the priority assigned to the
automation.

• Low
• Medium
• High

Current action Search for an activity based on
the current action.

User-specified action name

Current bot Search for an activity based
on the name of a bot that is
currently running.

User-specified bot name

Bot Search for an activity based on
the name of a bot.

User-specified bot name

Activity type Search for an activity based on
the activity type selected to run
a bot.

• Run Bot
• Import queue files
• Run bot with queue
• Export bots

Device Search for an activity based on
the device name on which it is
running.

User-specified device name

Nota:  For troubleshooting a bot that stuck on the In progress activity page, refer BOT stuck in In
Progress Stage and not able to move it to history" or "BOT stuck in Pending execution Stage and not able to move it
to history" on Automation 360 CLOUD and On-Prem environments.

Azioni

You can pause, resume, stop, move, export, and refresh the activities or items by using the actions in the
Historical page. Hover over the actions icon (vertical ellipsis) to enable and use the following actions:

Pause checked items To pause the selected items
Resume checked items To resume the selected paused items
Stop checked items To stop the selected items
Move checked items to history To stop the selected items
Move checked items to history To move the selected activity from In progress to

the Historical page.
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Nota:  For Workload automation, you cannot
Stop, Pause/Resume, or Move checked items
to history if the TaskBot status is Active or
Unknown .

Export checked items to CSV To export selected items to a CSV file based on the
following parameters:
• Filters
• Selection

Refresh table To refresh the table with updated activity details
Customize columns To show or hide specific columns

Importante:  Multiple workload automation entries equaling the number of devices are shown on the
In-progress activity page if the work items added to a queue are fewer than the number of devices
available in a device pool. For details about a workload automation, see the View queue details page on
the user device on which the workload automation is deployed.

Cronologia attività
You can search, view, and run previously created bots in the Activity > Historical page.

Search parameters

Based on the administrative permissions, you can apply various search parameters to monitor and find the
required historical activities. The following table describes various search parameters, their description, and
possible values or examples to search the historical activities:

Parametro Descrizione Possible values and examples

Status Search for an activity based on
its status.

• Completed
• Failed
• Stopped
• Timed out
• Unknown
• Deploy failed
• Run failed
• Pending execution

Item name Search for an activity based on
triggered item.

A generic name in specif system
format with combination of your
bot name, date and time when
you run the bot, and username
by which you run the bot.
For example,
recorder_Recorder_2.7.3-20220527-004608.2022.07.04.09.32.16.botcreator
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Parametro Descrizione Possible values and examples

Automation priority Search for an activity based
on the priority assigned to the
automation.

• Low
• Medium
• High

Device name Search for an activity based
on the name of the device on
which the activity is running.

User-specified device name

Bot name Search for an activity based on
the name of a bot.

User-specified bot name

User Search for an activity based
on the name of the user who
created the activity.

User specified name

Azioni

You can export, refresh, and customize the activity details in the Activity > Historical page.

Export checked items to CSV To export selected items to a CSV file based on the
following parameters:
• Filters
• Selection

Refresh table To refresh the table with updated activity details
Customize columns To show or hide specific columns

Importante:  Multiple workload automation entries equal to the number of devices are shown on the
Historical activity page, if the work items added to a queue are less than the number of devices
available in a device pool. For workload automation details, refer to the View queue details page on the
actual user device on which the workload automation was deployed.

Visualizza attività completate
You can view a list of all completed activities and corresponding information in the Activity > Historical
page.

Attività completate

You can use the Status search parameter and view all the completed activities in the Historical page.
You can export data in the table in CSV format, customize columns, and refresh the list in the table for the
completed activities.
Il periodo di conservazione delle informazioni sull'esecuzione del bot nella pagina Cronologia varia in base
alla distribuzione. Il periodo di conservazione per le varie distribuzioni è elencato nella tabella seguente:

Distribuzione Periodo di conservazione (giorni)

Community Edition 30
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Distribuzione Periodo di conservazione (giorni)

Cloud 90

On-Premises Illimitato (nessuna cancellazione automatica)

Nota:
• For On-Premises deployment, the bot execution information beyond the specified retention period is

available in the audit log and these logs are not deleted.
• For Cloud deployment, see  Automation 360 Cloud Data Retention Policy.

Nota:
• Specify search parameters for the same column using OR operator.
• Specify search parameters for different columns, the system searches using AND operator.

You can perform the following actions for a table of completed activities:
• Sort the column items in ascending or descending order.
• Drag-and-drop columns to move or change the column sequence.
• Resize the column width.

Activity details

The following table describes various details for completed activities:

Parametro Descrizione Possible values and examples

Status Search for an activity based on
its status.

Completed

Item name Search for an activity based on
triggered item.

A generic name in specif system
format with combination of your
bot name, date and time when
you run the bot, and username
by which you run the bot.
For example,
recorder_Recorder_2.7.3-20220527-004608.2022.07.04.09.32.16.botcreator

Automation priority Search for an activity based
on the priority assigned to the
automation.

• Low
• Medium
• High

Device name Search for an activity based
on the name of the device on
which the activity is running.

User-specified device name

Bot name Search for an activity based on
the name of a bot.

User-specified bot name
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Parametro Descrizione Possible values and examples

User Search for an activity based
on the name of the user who
created the activity.

User specified name

Started on La data e l'ora in cui l'attività è
stata iniziata.

For example, 19:01:24IST
2022-06-06

Ended on The date and time when the
activity was ended.

For example, 19:01:40IST
2022-06-06

Last modified The time when activity was last
modified.

For example, 57 minutes ago or 3
weeks ago

Modified by The name of the user who
changes the activity.

User-specified name

Azioni

You can view any individual item using the following action:

Visualizza Visualizza i dettagli dell'attività completata.

Scheduled activities
Schedule bots to run on unattended Bot Runners from the Scheduled tab in the Control Room.

Panoramica

Edit, view, activate, deactivate, delete a schedule, export selected activity details to a CSV file, and search
by activity name.
Perform the following actions on a column:
• Click a column to sort it in ascending or descending order.
• Use a drag-and-drop operation to move the column left or right.
• Move the mouse cursor to the end of the column and drag to re-size.

Schedule Actions

Perform the following tasks on an individual Schedule by moving your mouse over the Actions icon.

Programmare un bot
Programma un bot da eseguire a un'ora specifica.
Assicurati di aver effettuato l'accesso alla Control Room come amministratore o come utente con le
seguenti autorizzazioni:
• Programma i miei bots per l'esecuzione
• Pianifica l'autorizzazione a livello di cartella per bots specifici e le relative dipendenze
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• Accesso a (Bot Runners) Esegui come utenti che puoi aggiungere alla pianificazione

Nota:  L'automazione avrà esito negativo nei seguenti casi:
• Se risulta mancante una delle dipendenze del bot.
• Se non disponi dei privilegi di cartella sulle dipendenze.
• Se non disponi delle autorizzazioni di programmazione.

1. Navigate to Manage > Scheduled.
2. Fai clic su Esegui bot.
3. Click Schedule bot.
4. Aggiungi i dettagli di programmazione per il bot.

Nota:  Il valore della casella Data di inizio  è sempre successivo o uguale alla data attuale. Se la
data di inizio è quella attuale, l'ora programmata non può essere anteriore all'ora attuale.

Opzione Definizione

Esegui una sola volta Per eseguire il bot a un orario specificato,
immetti:

Data di inizio Il valore predefinito è il
giorno corrente.

Ora di inizio Il valore predefinito
è arrotondato alla
mezz'ora successiva.

Fuso orario User's system time
zone
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Opzione Definizione

Ripeti esecuzione Per pianificare l'esecuzione di un bot in un
determinato giorno a un'ora specifica, inserisci:

Data di inizio Il valore predefinito è il
giorno corrente.

Data di fine Il valore predefinito del
campo è vuoto.

Ora di inizio Il valore predefinito
è arrotondato alla
mezz'ora successiva.

Fuso orario User's system time
zone

Nota:
When the daylight saving is enabled and if the
Start date is set for a schedule, the Start date
is shown in the time zone to which it belongs
to and not as per the user's current time zone.
However, Next occurrence is shown in the time
zone (user's system time zone) as per daylight
saving time.
For example, for a schedule created on 15th
March in GMT time zone, the Start date is
shown as Mar-15th which belongs to GMT time
zone. Later, when daylight saving is ON and
if you edit or view this schedule in the month
of August in BST time zone, next occurrence
is shown as current August month date which
belongs to BST time zone.
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5. In the Missed schedule setting section, select Redeploy the schedule again to redeploy a
schedule that was missed because of Control Room shut down.

Nota:  To ensure a successful deployment when using the Redeploy the schedule again option,
you must start the compiler service before you restart the Control Room services.

When the Redeploy the schedule again option is selected, schedules missed because of Control
Room shut down are automatically redeployed after the Control Room is restarted. An audit log entry
is also added showing the Event type as Schedule misfired.

6. Seleziona il bot da pianificare.
• Versione più aggiornata: Fai clic sulla scheda Versione più aggiornata per selezionare la versione

più aggiornata del bot.
• Versione con etichetta: Fai clic sulla Versione di produzione per selezionare la versione con

etichetta del bot.

I bots disponibili vengono visualizzati insieme a tutti i Valori di input e alle dipendenze. Se l'opzione
etichetta di produzione è selezionata per il bot padre, vengono selezionati automaticamente anche i
corrispondenti bots dipendenti con l'etichetta di produzione. Se uno qualsiasi dei bots dipendenti non
ha l'etichetta di produzione applicata, viene selezionata la versione più aggiornata del bot.

7. Seleziona l'utente Bot Runner dall'elenco Esecutori di bot disponibili.
Use the following options to define the number of Bot Runners to use:
• All bot runners: Select to use all the selected Bot Runners.
• Custom number of bot runners: Select to customize the number of Bot Runners to use from

the list of selected Bot Runners. The Control Room will then automatically select the configured
number of Bot Runners from the list of available Bot Runners.

Nota:  Se un (Bot Runner) Esegui come utente non è presente nell'elenco, verifica che all'utente
che programma il bots sia assegnato un ruolo che consenta l'accesso al comando Esegui come utenti
appropriato.

8. Click the right arrow (→) to add your selection.
9. Opzionale: Select Device Pools.

Select the pool from the list of available device pools. If any of the selected run-as users does not
have the bot running device, a device pool is required. You can select up to 25 device pools per
schedule.
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10. Opzionale: Click the up or down arrow to set the selected device pools in preferred order.
Quando un  viene distribuito, la  seleziona il primo dispositivo disponibile in base all'ordine in cui
sono stati organizzati i pool di dispositivi. Se nessuno dei dispositivi è disponibile al momento della
distribuzione, il  viene messo in coda.

11. Inserisci il Nome.
12. Opzionale: Immetti una descrizione.
13. Seleziona la Priorità di automazione dalla scheda Generale.

Imposta la priorità su alta, media o bassa in base alle tue esigenze per l'ottimizzazione delle risorse. Il
valore predefinito è media.

14. Click Schedule bot.

The Schedule bot option remains disabled until all the required items, such as bots, schedule details, and
devices are selected.
The number of times a bot is deployed depends on the run-as users (Bot Runners) selected for the
schedule. Consider the following scenarios:
• The number of run-as users selected is two, and both the users have the bot running device: The bot is

deployed twice on the two run-as users and their bot running devices.
• The number of run-as users selected is three, and only one of the users has the bot running device. In

this case, you must select the device pool. If the device pool has only two devices, the bot is deployed
three times on both the devices in the device pool and also on the bot running device of the third user.

• The number of run-as users selected is three, and none of the three users has the bot running device:
In this case, you must select the device pool. If the device pool has only two devices, the bot is
deployed twice on both the devices in the device pool, and the third request for bot deployment is
queued. The bot is deployed only when a device becomes available in the device pool.

• The number of run-as users selected is two, and none of the two users have the bot running device: In
this case, you must select the device pool. If the device pool has four devices, the bot is deployed twice
on any available two devices in the device pool.

Concetti correlati
Bot permissions for a role alla pagina 2706
Assign bot permissions when creating a role with the View my bots feature permission.
Attività correlate
Edit a scheduled activity alla pagina 2620
Make changes to a schedule so that the automation is not skipped.
Delete a scheduled activity alla pagina 2622
Delete a scheduled activity.

Edit a scheduled activity
Make changes to a schedule so that the automation is not skipped.
Ensure that you are logged in to the  as the administrator.
Edit the scheduled activity in order to:
• Change the schedule type, date, or time.
• Add or remove Bot Runners from the schedule.
• Change the retry settings.
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Nota:  The system redeploys the bots and dependencies only if there are updates to the bots or its
dependent files.

1. Hover over the Actions icon for the scheduled  in the Activity table.
2. Click the Edit icon. ( )
3. Make changes to the schedule details, bots, and devices, as required.

Opzione Definizione

Esegui una sola volta Per eseguire il bot a un orario specificato,
immetti:

Data di inizio Il valore predefinito è il
giorno corrente.

Ora di inizio Il valore predefinito
è arrotondato alla
mezz'ora successiva.

Fuso orario User's system time
zone

Ripeti esecuzione Per pianificare l'esecuzione di un bot in un
determinato giorno a un'ora specifica, inserisci:

Data di inizio Il valore predefinito è il
giorno corrente.

Data di fine Il valore predefinito del
campo è vuoto.

Ora di inizio Il valore predefinito
è arrotondato alla
mezz'ora successiva.

Fuso orario User's system time
zone

Nota:
When the daylight saving is enabled and if the
Start date is set for a schedule, the Start date
is shown in the time zone to which it belongs
to and not as per the user's current time zone.
However, Next occurrence is shown in the time
zone (user's system time zone) as per daylight
saving time.
For example, for a schedule created on 15th
March in GMT time zone, the Start date is
shown as Mar-15th which belongs to GMT time
zone. Later, when daylight saving is ON and
if you edit or view this schedule in the month
of August in BST time zone, next occurrence
is shown as current August month date which
belongs to BST time zone.
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4. In the Missed schedule setting section, select Redeploy the schedule again to redeploy a
schedule that was missed because of Control Room shut down.

Nota:  To ensure a successful deployment when using the Redeploy the schedule again option,
you must start the compiler service before you restart the Control Room services.

When the Redeploy the schedule again option is selected, schedules missed because of Control
Room shut down are automatically redeployed after the Control Room is restarted. An audit log entry
is also added showing the Event type as Schedule misfired.

5. Select Device pools.
Select the pool from the list of available device pools.

6. Opzionale: Click the up or down arrow to set the selected device pools in preferred order.
7. Opzionale: Change the Automation priority from the General tab.
8. Click Schedule bot.

The Schedule bot option remains disabled until all the required items, such as bots, schedule details, and
devices are selected.
The number of times a bot is deployed depends on the run-as users (Bot Runners) selected for the
schedule. Consider the following scenarios:
• The number of run-as users selected is two, and both the users have the bot running device: The bot is

deployed twice on the two run-as users and their bot running devices.
• The number of run-as users selected is three, and only one of the users has the bot running device. In

this case, you must select the device pool. If the device pool has only two devices, the bot is deployed
three times on both the devices in the device pool and also on the bot running device of the third user.

• The number of run-as users selected is three, and none of the three users has the bot running device:
In this case, you must select the device pool. If the device pool has only two devices, the bot is
deployed twice on both the devices in the device pool, and the third request for bot deployment is
queued. The bot is deployed only when a device becomes available in the device pool.

• The number of run-as users selected is two, and none of the two users have the bot running device: In
this case, you must select the device pool. If the device pool has four devices, the bot is deployed twice
on any available two devices in the device pool.

Attività correlate
Programmare un bot alla pagina 2616
Programma un bot da eseguire a un'ora specifica.
Delete a scheduled activity alla pagina 2622
Delete a scheduled activity.

Delete a scheduled activity
Delete a scheduled activity.
Ensure that you are logged in to the  as the administrator.
To delete a scheduled activity:
1. Hover over the Actions icon for the scheduled  in the Activity table.
2. Click Delete.

Confirm or cancel.
3. Click Yes, delete.
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Attività correlate
Programmare un bot alla pagina 2616
Programma un bot da eseguire a un'ora specifica.
Edit a scheduled activity alla pagina 2620
Make changes to a schedule so that the automation is not skipped.

Automatically select the number of Bot Runners users
Scale your automation by allowing Automation 360 to automatically select the Bot Runner users for specific
tasks.
You can enable Automation 360 to automatically select the Bot Runner users for specific tasks:
• Scale automations easily
• Run bots concurrently
• Use resources efficiently

You can optimize Bot Runner users by selecting how many Bot Runners you want to use to run tasks
concurrently. The system automatically selects the number of Bot Runner users that are available for the
tasks. As a result, when you run or schedule an automation, the available run-as users are automatically
selected from the specified list.
Let us consider the following example:
• You have three bots: Bot 1, Bot 2, and Bot 3.
• You have two Bot Runner licenses: bruser 1 and bruser 2.

You can use any of the Bot Runner users to run the three bots by performing the following procedure:
1. Create schedules to run these bots.
2. Select these bots to run.
3. Select both Bot Runner users.
4. Specify Custom number of bot runners to use as 1 so that one of the Bot Runners is used to run

these bots.
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See the following video on how Automation 360 automatically selects the Bot Runner users for specific
tasks:
To customize Bot Runners, see Programmare un bot alla pagina 2616.

Trigger di evento
Un trigger di evento è un'azione predefinita che esegue un bot associato. Tutti i bots con trigger di evento
sono elencati nella scheda Trigger di evento.

Autorizzazioni di ruolo disponibili per i trigger di evento

L'amministratore della Control Room deve fornire le autorizzazioni necessarie per assicurare che gli utenti
associati possano accedere ai trigger di evento. La seguente tabella elenca le autorizzazioni disponibili:

Autorizzazione Descrizione

Visualizza trigger di
evento

Select this permission if the users can only view the event triggers but
not run or delete them.
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Autorizzazione Descrizione

Manage event triggers The Manage event triggers permission is available only if View
event triggers is enabled. Seleziona questa autorizzazione se gli utenti
possono:
• Add an event trigger

Nota:  Users associated with the Bot Creator license cannot add
event triggers in the private workspace.

• Eseguire un bot con trigger di evento
• Eliminare un trigger di evento
• Associare un trigger di evento a un utente Bot Runner (assistito o

non assistito) o a un ruolo associato a uno o più utenti Bot Runner
(assistiti o non assistiti).

Supported actions

In Automation 360, fai clic su Gestisci > Trigger di evento per visualizzare la tabella che elenca tutti i
bots con trigger di evento. The following actions are available for this table.
• Inserisci una parola chiave da PERCORSO BOT nel campo Cerca per trovare un trigger di evento.

Ad esempio, se il percorso del bot di un trigger di evento è Bots\file--created--event--
Salesinfo, immetti Vendite nel campo Cerca per trovare questo trigger di evento.

• Utilizza l'opzione Esegui con trigger di evento per aggiungere trigger di evento.
Adding event triggers alla pagina 2626

• L'utente può anche eliminare qualsiasi trigger di evento associato (attivo o inattivo).

© 2023 Automation Anywhere. All rights reserved.     2625



    Automation Anywhere - Gestisci

• View the trigger status, bot path, user name, role, and modification details.
Facoltativo: On the specific device, to view trigger details:
1. Open the Task Manager > Details tab.
2. Right-click on the column in the list of app entries.
3. Click Select columns.
4. Click Command Line item to enable the column.

Verify that the following Java processes are running to confirm that the triggers are active:
• Agente Bot o gestore di nodi

Nota:  The name for this is java.exe

• Ascoltatore di trigger

Nota:  The name for this is javaw.exe

Facoltativo: To confirm that java.exe or javaw.exe are associated with a node manager or trigger
listener, respectively:
1. Copy the details of this task

Press CTRL+C after you clicked the task name.
2. Paste the details to a notepad.
3. Verify the jar files.

Nota:  Node manager is node-manager.jar and the trigger listener is triggerlistener.jar

Consideriamo uno scenario in cui i trigger sono associati a un utente Bot Runner che si disconnette
o esce da un dispositivo. Questo utente Bot Runner utente deve accedere alla Control Room su quel
dispositivo per attivare i trigger associati.

Concetti correlati
Adding a trigger to run a bot alla pagina 2207
Add triggers that can automatically run the selected bot whenever a specific event occurs. For example,
clicking a specific button or using a combination of keystrokes.

Adding event triggers
Any bot with triggers can be associated with users or role to enable event trigger. Control Room user (or
role) with Manage event triggers permission can add event triggers.
All the bots a user creates are displayed in the Private tab. When the user checks in a bot to a public
folder, it is displayed in the Public tab.
A private event trigger is created when a user with the Manage event triggers permission adds a
trigger to a bot but does not check in this bot to a public folder. Private event triggers are listed under the
Manage > Event triggers page. However, if the user checks in the associated bot to a public folder, it is
no longer displayed under the Event triggers page.
1. Nel pannello di sinistra, fai clic su Automazione.
2. Fai clic su Esegui bot.
3. Click Run with event triggers.
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4. Select the bot.
• Versione più aggiornata: Fai clic sulla scheda Versione più aggiornata per selezionare la versione

più aggiornata del bot.
• Versione con etichetta: Fai clic sulla Versione di produzione per selezionare la versione con

etichetta del bot.

Se l'opzione etichetta di produzione è selezionata per il bot padre, vengono selezionati
automaticamente anche i corrispondenti bots dipendenti con l'etichetta di produzione. Se uno qualsiasi
dei bots dipendenti non ha l'etichetta di produzione applicata, viene selezionata la versione più
aggiornata del bot.

5. Click the right arrow (→) to add your selection.
6. Fai clic su Avanti.
7. Seleziona una delle seguenti opzioni per collegare il bot:

Opzione Descrizione

Ruoli Seleziona il ruolo personalizzato creato.

Utenti Seleziona l'utente Bot Runner (assistito o non assistito) associato a questo
ruolo personalizzato.

8. Click the right arrow (→) to add your selection.
9. Fai clic su Avanti.
10. Click Run with event triggers.

The selected bot is added to the Event triggers page under Activity.
Concetti correlati
Working with bots alla pagina 1991
Depending on the license and permission assigned to you, you can perform various bot operations and
access the private and public workspaces in the Control Room.

Collegamento di trigger di evento a un Bot Runner
An Control Room administrator or users with Manage event triggers permission can add event triggers
by associating users or roles with a bot. Ciò consente agli utenti Bot Runner di attivare bot quando
eseguono un evento specificato.
Quando un utente con una licenza Bot Creator crea un bot e lo controlla in un archivio, bot è disponibile
nello spazio di lavoro Pubblico. Un amministratore Control Room o utente con autorizzazione Gestisci
trigger di evento e l'accesso a questo spazio di lavoro Pubblico può quindi collegare un trigger di
evento.
Un utente Bot Runner (assistito o non assistito) deve accedere alla Control Room per avviare il trigger di
evento, quindi può scegliere di disconnettersi dopo l'attivazione di tale trigger di evento.
Come opzione facoltativa, l'amministratore può anche abilitare la funzione di accesso automatico nella
Control Room per gli utenti Bot Runner non assistiti.
Consulta Configure auto-login settings alla pagina 2732.

Nota:  Tra tutti i trigger, puoi associare qualsiasi trigger solo con un utente che dispone di una licenza
Bot Runner. Inoltre, per un utente con licenza Bot Runner non assistita, se associ trigger come Tasto di
scelta rapida, Interfaccia o Finestra, si applicano le seguenti condizioni:
• Il dispositivo predefinito non deve essere nello stato disconnesso o bloccato.
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• L'utente deve aver effettuato l'accesso al dispositivo per eseguire un'attività predefinita che può attivare
il bot.

1. Nel pannello di sinistra, fai clic su Automazione.
2. Fai clic su Esegui bot.
3. Click Run with event triggers.
4. Select the bot.

• Versione più aggiornata: Fai clic sulla scheda Versione più aggiornata per selezionare la versione
più aggiornata del bot.

• Versione con etichetta: Fai clic sulla Versione di produzione per selezionare la versione con
etichetta del bot.

Se l'opzione etichetta di produzione è selezionata per il bot padre, vengono selezionati
automaticamente anche i corrispondenti bots dipendenti con l'etichetta di produzione. Se uno qualsiasi
dei bots dipendenti non ha l'etichetta di produzione applicata, viene selezionata la versione più
aggiornata del bot.

5. Click the right arrow (→) to add your selection.
6. Fai clic su Avanti.
7. Seleziona una delle seguenti opzioni per collegare il bot:

Opzione Descrizione

Ruoli Seleziona il ruolo personalizzato creato.

Utenti Seleziona l'utente Bot Runner (assistito o non assistito) associato a questo
ruolo personalizzato.

8. Click Add event triggers.

Quando l'utente Bot Runner accede a Control Room ed esegue il trigger di evento, il bot viene distribuito. Il
trigger di evento continuerà a funzionare fin quando non sarà apportata una delle seguenti modifiche:
• Il bot associato viene eliminato dallo spazio di lavoro pubblico.
• L'account dell'utente Bot Runner collegato viene eliminato.
• Il dispositivo predefinito è disconnesso.

Dispositivi
Il dispositivo è una macchina attraverso la quale un utente si connette alla Control Room per creare o
eseguire bots. Manage devices that are registered to the Control Room through the Devices page located
in the Manage tab.

Attività eseguite dalla pagina Dispositivi

As a Control Room user with Bot Runner, Bot Creator, and Device pools privileges, use the Devices page
to perform the following actions:
• View a list of devices registered and connected to the current instance of the Control Room.
• Create and view a list of device pools available from the current instance of the Control Room.
• Run bots immediately on selected Bot Runners.

If the device is already registered by another user other than the Bot Creator and the Bot Creator does
not have the Register device permission or the associated device assigned to it, when you run
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a bot from the bot editor window, the deployment fails with an insufficient permission error
message.

• Schedule bots to run on selected Bot Runners.
• Run bots on selected device pools.

Nota:
• Only an admin user has access to view all the devices in the Control Room. A non-admin user does not

have access to view Bot Creators.
• Only one Bot Creator can be logged in to a device to run bots at any one time. For a new user as a Bot

Creator on the same device, the first Bot Creator has to be removed.

Dispositivi
La pagina I miei dispositivi visualizza tutti i dispositivi configurati e lo stato attuale per ciascun
dispositivo elencato. Devices are identified by IP and hostname. A device can be in one of the following
states:

Connesso Device is logged in to the Control Room.

Nota:  Attendi 35 secondi affinché un dispositivo
appaia come collegato nell'elenco dei dispositivi
dopo aver rimosso e registrato nuovamente il
dispositivo.

Disconnesso Device is not logged in to the Control Room.
Non in linea Device has been unregistered or disabled by the

Control Room administrator.

Sono abilitate le seguenti azioni:

Connetti dispositivo locale Install Bot Agent on your local device and connect it
to Control Room. In order to run bots on that local
device, ensure that you add it to the list of enabled
host devices.

Run bot now with checked items Runs the bot on selected device.
Export checked items to CSV Exports the data to a CSV file based on:

• Filters
• Selection

Aggiorna tabella Refreshes the table contents to view the updated
status.

Personalizza colonne Show or hide specific columns.
View and edit device Con l'autorizzazione Visualizza e gestisci TUTTI

i dispositivi è possibile visualizzare e modificare le
seguenti impostazioni dei dispositivi:
• Nome
• Stato
• Versione Bot Agent
• Nome pool di dispositivi
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• Nickname (facoltativo)
• Descrizione
• Device type (single user or multiple users)

In caso di dispositivo multi-utente, è possibile
modificare il campo Sessioni simultanee
supportate.

• Add or edit device permissions
• Risoluzione dello schermo

You can set the screen resolution by either
selecting a value from the predefined resolution
drop-down list or by selecting custom and
entering the values.
• You can edit only the nickname, description,

device type, and screen resolution fields.
• Assicurati di aver selezionato l'opzione

Consenti ai dispositivi di ignorare
le impostazioni di risoluzione nelle
impostazioni della Control Room per rendere
effettiva la risoluzione a livello di dispositivo.

Nota:  The screen resolution settings are
applicable only when you use RDP-based
deployments. For regular deployments, a
Windows session is created using the existing
resolution settings of the device. In this case,
the screen resolution set in the Control Room is
ignored.

• Durata
La durata del dispositivo può essere
Permanente o Temporanea. Temporary
devices are created to support non-persistent
virtual desktop infrastructure (VDI) and are
automatically deleted after a specified time
when the device is disconnected from the
Control Room. You can specify the time to
automatically delete temporary devices in the
Control Room devices settings.
Persistent devices are created to support
persistent virtual desktop infrastructure
(VDI) and are not deleted after the device is
disconnected from the Control Room.

• Impostazioni di accesso automatico
È possibile personalizzare le impostazioni di
accesso automatico per ciascun dispositivo.
Scegli tra le impostazioni configurate in Control
Room o a livello del dispositivo selezionato
per creare nuove sessioni utente oppure
utilizzare le sessioni utente esistenti al termine
dell'esecuzione di un bot.
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• Tipo di installazione
Questa impostazione si basa sul fatto che Bot
Agent sia installato a livello utente o a livello di
sistema sul dispositivo dell'utente.

• Tipo di distribuzione
Questa impostazione è basata sul tipo di utente
e sul tipo di installazione. In caso di singoli
utenti installati a livello di sistema, il tipo di
distribuzione predefinito è regolare. In caso
di più utenti installati a livello di sistema, la
distribuzione predefinita è RDP.

Precarica i pacchetti Utilizza i pacchetti precaricati per scaricare
i pacchetti più comunemente utilizzati o
personalizzati sul tuo dispositivo locale. Poiché
i pacchetti vengono salvati non in linea sul
dispositivo, quando si esegue un bot, il sistema
salta il processo di scaricamento del pacchetto
e inizia l'esecuzione del bot riducendo così
il tempo di esecuzione del bot in questione.
Puoi scaricare versioni specifiche del pacchetto
nella cartella del dispositivo dell'utente C:
\ProgramData\AutomationAnywhere
\AAPreloadedPackages.

Pool di dispositivi

Device pools provide a logical grouping of similar Bot Runners to run bots with the work items from a
queue. For example, group devices of a particular department or unit and create a device pool for it.
Attività correlate
Installazione di Bot Agent e registrazione del dispositivo alla pagina 1039
Install Bot Agent on your local device and connect it to Control Room. In order to run bots on that local
device, ensure that you add it to the list of enabled host devices.
Set user device credentials alla pagina 1052
Per abilitare un dispositivo per l'esecuzione di bots, imposta le credenziali del dispositivo locale.
Configure auto-login settings alla pagina 2732
Configure auto-login settings in the Control Room to either create user sessions or reuse existing user
sessions to reduce the bot startup time.

About multi-user devices
A multi-user device is any Windows terminal server device (Windows 2019, Windows 2016, Windows 2012,
Windows 10 Enterprise on Azure) which enables multiple users to concurrently log in to a single device.
The multi-user device server enables multiple users to access the same operating system and share the
hardware, performing the tasks for each user concurrently. In multi-user devices, bots are deployed using
RDP.
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Benefits of a multi-user device

A multi-user device ensure that each machine in an organization is fully used, reducing the hardware and
software cost by enabling different users to access the same device. Bot Creator users and Bot Runner
(attended or unattended) users can be configured on a multi-user device. The multi-user device also
provides security and authentication for every user. Each user is assigned unique login credentials for the
device and can access only the assigned applications and device settings.

Nota:  In a multi-user device, if two user sessions with the same device credentials try to deploy a bot,
the deployment will fail for one of the user sessions. An appropriate failure message is recorded in the
audit log.

Multi-user device in a device pool

A multi-user device can be part of a device pool and the device can be set as the default device for Bot
Creator users and Bot Runner (attended and unattended ) users.

Set as default device

As a licensed user, when you log in to a non-default device, you can set that device as your default device.
You must have the View and manage ALL device(s) permission if you want to set another device that
is not registered by you as your default device: To set it as the default device, follow these steps:
1. Click the device icon on the top-right of your screen.
2. Select the Make default device option from the menu.

If you do not have the necessary permission, a message prompt appears, stating that you will lose access
to your current default device.

Configure RDP-based deployment for multi-user devices
RDP-based deployment is used for multi-user devices. When a bot is deployed for an unattended Bot
Runner from the Control Room, the Control Room handles the unattended Bot Runner session through
RDP and executes the bot.
Ensure that you are logged in to the Control Room as the administrator.
Assicurati che siano soddisfatti i seguenti requisiti:
• Active Directory Domain Services are set up (Optional).
• Remote Desktop Services (RDS) are set up on the machine ready to host multiple (RDS) bot runner

sessions (Mandatory).
• Active Directory/Local users are created (Mandatory).
• Users are provided access to RDS (Mandatory).
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When registering your device, you can register it as a multi-user device.
1. Change device type to multiple users.

a) Navigate to Manage > Devices.
b) Hover over the actions menu (three vertical ellipses) located to the right of the device name and

click the Edit device icon.
c) Under Deployment tab, change the Device type to Multiple users.
d) Enter a value for the Concurrent sessions supported field.

The maximum number of allowed concurrent sessions depends on your device license type and
the hardware configuration. For example, consider that concurrent sessions is set to 10 and
each bot requires 4 GB RAM for execution. If your system RAM is lower than this value, the bot
execution might fail.
Also, if the maximum number of sessions allowed in your device is 10 and the multi-user device
is set as the default device for 3 Bot Creator users and 2 attended Bot Runner users, then the
value for the concurrent sessions supported will be 5. Therefore, at a time, only 5 bots can be
deployed concurrently by the unattended Bot Runner users. So ensure that your hardware and
device license type support the number of sessions you set.

e) Fai clic su Salva modifiche.

2. Set the RDP screen resolution.
This ensures your automation runs seamlessly during RDP-based deployment, even if the resolution of
the screen varies between the Bot Runner and Control Room.
You can set it in the following ways:
• At the Control Room level: Configure screen resolution for a device session alla pagina 2730.
• At the device level: Dispositivi alla pagina 2628.

Note that you can update the screen resolution at device level only if the option to override screen
resolution is enabled in Administration > Settings > Devices.

3. Configure the RDP settings.
a) Select Devices option from Administration > Settings.
b) Edit the RDP settings for multiple user devices field.
c) Enter the Port.

Nota:  Use the default port 3389 for RDP-based bot deployments.

d) Enter the RDP session timeout value.
The default session timeout value is 60.

e) Fai clic su Salva modifiche.

4. By default clipboard data is shared across RDP sessions. Follow the below steps to prevent sharing of
clipboard data across multi-user RDP sessions:
a) Select Devices option from Administration > Settings.
b) Edit the Advanced options field.
c) In the RDP command options field, enter -clipboard.
d) Fai clic su Salva modifiche.

For more information about troubleshooting black screen and lock screen images, see
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• Black screenshot while running the bot in unattended mode (A-People login required)
• Black screen and lock screen images being captured (A-People login required)

1. Create users in the Control Room.
These users can be unattended Bot Runners, Attended Bot Runners, or Bot Creators. You can select
the multi-user option when you register the device for the first time. Consulta Create a user alla pagina
2684.

2. Associate the correct device and session login credentials based on the Active Directory users that you
create before configuring the multi-user device settings.
You can register an Active Directory user one time as an admin user and the sessions are created
when you deploy bots. You do not have to create an RDP session on the Bot Runners server and
register the device under an Active Directory user name and user credentials.

3. Deploy the bots on parallel sessions.

Nota:  If the multi-user device per sessions count provided is less than the actual bot deployment,
then the additional bot deployments are queued until the current deployments are in progress.

Convert an existing device to a multi-user device
If you have a server OS, multi-user OS, or hosted VMs such as AWS, Microsoft Azure, or VMware as the
Bot Runner machine, you can convert your existing device to a multi-user device.
Ensure that you are logged in to the  as the administrator.
Converting a device enables you to share the same device between Bot Runner and Bot Creator users
because they can coexist in different sessions simultaneously. Also, multiple parallel executions of a bot
can be performed on the same machine.
If you encounter Auto Login issues because multiple users are sharing the device or because it is a remote
device, convert your device to a multi-user device.
If you have a single-user device and want to use RDP-based deployment, then set the device type as
Multiple users and Concurrent sessions supported to 1.
1. Navigate to Manage > Devices.
2. Hover over the actions menu (three vertical ellipses) located to the right of the device name and click

the Edit device icon.
3. Under Deployment tab, change the Device type to Multiple users.
4. Enter a value for the Concurrent sessions supported field.

The maximum number of allowed concurrent sessions depends on your device license type and the
hardware configuration. For example, consider that concurrent sessions is set to 10 and each bot
requires 4 GB RAM for execution. If your system RAM is lower than this value, the bot execution might
fail.
Also, if the maximum number of sessions allowed in your device is 10 and the multi-user device is
set as the default device for 3 Bot Creator users and 2 attended Bot Runner users, then the value
for the concurrent sessions supported will be 5. Therefore, at a time, only 5 bots can be deployed
concurrently by the unattended Bot Runner users. So ensure that your hardware and device license
type support the number of sessions you set.

5. Fai clic su Salva modifiche.
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About device pools
Device pools are a logical grouping of devices or similar unattended Bot Runner machines on which you
can run your workload management automations or scheduled unattended automations. For example, you
can group the devices (system-wide type) of a specific department or unit and create a device pool.

Panoramica

You can use a device pool to restrict bot deployments to a specific set of devices that are available from
your Control Room instance and take advantage of any device available in a device pool because any
device in the device pool can run the bot.
You can also use a device pool to process work items from workload management queues. Workload
management distributes work items across various devices in a device pool. This distribution of work items
ensures efficient bot processing through optimal usage of devices and Automation 360 licenses. Device
pools can contain different types of devices, such as single-user devices or muti-user devices.
You can share the device pool between multiple automations such as workload management, Run bot,
and Schedule bot, thus improving the device utilization.

How a device pool works

When you deploy an unattended bot to a device pool at run time, system identifies the available devices
from the pool. System starts with first device from the pool, if the first device is busy, it checks for next
device and then the bot is automatically sent to the available device from the list of system-wide devices.
As the other bots are deployed, they can run concurrently on the other devices in the device pool. By
dynamically allocating devices when bots are deployed, bot deployments are executed quickly and
efficiently.

High availability (HA) in device pools

Device pools provide built-in High Availability (HA) for the Bot Runner machines if your unattended
license is free to use. You are not tied to a single Bot Runner machine, so if your Bot Runner machine is
unavailable for any reason and your unattended license is free for deployment, your automation is not
affected. The scheduled automation will automatically run on the next available Bot Runner machine,
thereby providing high availability.

Nota:  Consider the following points when working with user credentials:
• Only one user credential can be attached to a licensed user.
• If all devices in a device pool are domain integrated and Active Directory users have access to all

devices, licensed users can login to any device by using attached user credentials.
• For more information about running bots in device pool, see Considerations for running a bot alla pagina

1995.

Managing device pools

As a device pool administrator, you can create, edit, and view all device pools that can be used for
scheduling automations and workload management.
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As a device pool owner or consumer, you can view only those device pools of which you are the owner
or consumer. Only users with the AAE_Queue Admin and AAE_Pool Admin role can perform device
management tasks.

Nota:  You have to create device pools to view those in the list.

To easily access your device pool, you can search by a device pool name.
• Click a column to sort it in ascending and descending order. You can sort up to three columns by

holding the Shift key when you click two more columns. This enables you to sort two additional
columns. The sorting is done on the entire table and not just the data that is currently visible to you.
The last sorting is stored in memory applied by a user per session.

• Use a drag-and-drop operation to move the column left or right.
• Move your mouse cursor at the end of the column and drag to resize.

Crea pool di dispositivi
Create a device pool with a unique name and add Unattended Bot Runners to the device pool.
• Ensure that you have one of the following roles to view the Device Pools tab:

• Device pool owner
• Device pool admin

• Ensure that you have a role with Create device pools permission to create a device pool.

Nota:  A Control Room administrator without device pool admin rights cannot view or create a device
pool.

• To add a device in the device pool, you must install it as a system-wide device (Bot Agent).
• After you add the device, you cannot add the same device to another device pool.

• You can add only those Unattended Bot Runners that are not part of any other pool.

Limitazione:  Unattended Bot Runners that are a part of other device pools are disabled for selection.

• You can use the Scheduled automations and Run with Queue automations options to run bots
on that device.

• You can add Control Room user roles as consumers. Only users with these roles can use the pool for
any automation.

• You can select only those devices with the Bot Runner installed at the system wide.
• If the devices in a device pool are more than the number of work items added to a queue, multiple

entries equal to the number of devices are shown in the Control Room In-progress activity and
Historical pages. For details, refer to the View queue details page on the actual user device on
which the workload automation is deployed.

To create a device pool, perform the following steps:
1. Navigate to Manage > Device pools.
2. Click Create device pool.
3. Inserisci il Nome.
4. Opzionale: Immetti una descrizione.
5. Select the Devices from the list of .
6. Click the right arrow (→) to add your selection.
7. Fai clic su Avanti.
8. Select the Device Pool Owners.
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9. Select user(s) from the Available users list.

Suggerimento:  Search the list of users based on their Username, First name, or Last name.

10. Click the right arrow (→) to add your selection.
11. Fai clic su Avanti.
12. Opzionale: Select the Device Pool Consumers.

Complete this step to enable device pool consumers to view the device pool when they run the
automation for the bot with a queue by following the next set of steps.

13. Opzionale: Select a Role from the list of Available roles.
14. Click the right arrow (→) to add your selection.
15. Click Create device pool.

The device pools for which you have consumer privileges are listed in the My Device Pools page.
View device pool details alla pagina 2637
Attività correlate
Esegui bot con coda alla pagina 2807
Puoi elaborare collettivamente tutti gli elementi di lavoro di una coda in tutti i Bot Runners presenti in uno
o più pool di dispositivi.

View device pool details
As a Control Room user with device pool management privileges or as a device pool owner, you can view
device pool details to ensure the information provided is correct and if required customize as per your
automation requirement.
Ensure that you are logged in to the  as the administrator.
Use the Device pool details page to view automations that are scheduled to run with or without
workload. The following information is displayed as part of device pool data:

Automazioni Shows the automations that are using the device
pool and the order that is chosen to run those.
This is shown as the default view. To find an
automation quickly, use the search option using
Status, Automation name, Queue, or Activity type.
You can perform the following actions on a table
column:
• Click a column to sort it in ascending and

descending order. You can sort up to three
columns by holding the Shift key when you click
two more columns. This enables you to sort
two additional columns. The sorting is done on
the entire table and not just the data that is
currently visible to you. The last sorting is stored
in memory applied by a user per session.

• Use a drag-and-drop operation to move the
column left or right.

• Move your mouse cursor at the end of the
column and drag to resize.

Dispositivi Shows list of unattended Bot Runner devices that
are part of the device pool.
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Proprietari Shows list of device pool owners that are granted
permission to view, edit, and delete the device pool.
Crea pool di dispositivi alla pagina 2636

Consumatori Shows the list of device pool consumers who are
granted permission to view the device pool as an
option to running automations.
Crea pool di dispositivi alla pagina 2636

Dettagli generali Shows the last modified date and time, name of
the user who modified device pool details, and
the Object Type which is the component on which
modification was done.

The Scheduled Automations tab is selected by default. Automations that are created using Run bot
now or Schedule bot (upcoming schedules) on that device pool are listed.
The second tab, Run with Queue Automations lists the automations that are scheduled to run for
Workload using the option Run bot with queue.
To view device pool details:
1. Navigate to Manage > Device pools.
2. Hover over the Actions icon for the device pool and select View.

Select each tab to view the related details.

Edit device pools alla pagina 2638, or Esegui bot con coda alla pagina 2807.
Attività correlate
Crea pool di dispositivi alla pagina 2636
Create a device pool with a unique name and add Unattended Bot Runners to the device pool.
Delete device pools alla pagina 2640
Delete a device pool comprising of unattended Bot Runners after your entity's automation goals are
achieved and the device pools are no longer required.

Edit device pools
As a Control Room user with device pool management privileges or as a device pool owner, you can edit
device pool details to customize your automation requirements.
• You must have Device pool owner or Device pool admin roles to edit a device pool.
• Users without AAE_Admin role must have the following permissions to edit a device pool:

• View and manage ALL device(s) to add or delete the devices
• View Users and Roles basic information to add or delete the owners and consumers

• To add a device in the device pool, you must install it as a system-wide device (Bot Agent).
• After you add the device, you cannot add the same device to another device pool.

When you open the device pool in edit mode, you can update the queue details such as Bot Runner,
Owners, Participants, and Consumers.
1. Go to Manage > Device Pools.

The Device Pools tab is visible only if you have Device pool admin role or you are an owner of any
device pool.

2. Locate the device pool you want to edit, hover over the actions menu (vertical ellipsis), and click Edit.
You can also edit the device pool details in view mode. For more information, see View device pool

The Device pool details page is displayed with the default Scheduled Automations tab.
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3. Set the Queue Execution mode to edit workload automations.
Go to the Run with queue automations tab, then choose one of the following options to define the
order in which your automations run in the queues:
• Round robin: Runs your automations at equal time intervals in the Time slice field. Per ulteriori

informazioni, consulta Round Robin alla pagina 2639.
• Priority as shown in table: Runs your automations based on a priority defined in the priority

table. Per ulteriori informazioni, consulta Priorità come mostrata nella tabella alla pagina 2639.

4. Update the list of unattended Bot Runner devices that are included in the device pool.
5. Update the list of device pool owners who are granted permission to view, edit, and delete the device

pool.
6. Update the list of device pool consumers who are granted permission to view the device pool.
7. Fai clic su Salva modifiche.

Attività correlate
Crea pool di dispositivi alla pagina 2636
Create a device pool with a unique name and add Unattended Bot Runners to the device pool.
Delete device pools alla pagina 2640
Delete a device pool comprising of unattended Bot Runners after your entity's automation goals are
achieved and the device pools are no longer required.
View device pool details alla pagina 2637
As a Control Room user with device pool management privileges or as a device pool owner, you can view
device pool details to ensure the information provided is correct and if required customize as per your
automation requirement.

Order of the automation queue
You can define the order in which your automations run in the queues.
This topic describes options of orders in which you can run the automation queues.

Round Robin

This option runs your automations at equal time intervals specified in the Time slice field. You can set a
Time slice in seconds, minutes, or hours and you can calculate or estimate the time for each automation,
and then provide this number.
• The default time slice is 60 minutes.
• The time slice cannot be set to zero.

Automations are executed for 60 minutes first, then the system checks for other automations in queue
for execution. If there are other automations in the queue, that automation is paused and the next
automation is executed. This method continues until all automations in the queue are executed.

Priorità come mostrata nella tabella

With this option, automations run based on a priority defined in the priority table. You can run automations
in the order of priority and set the individual priorities for each of the queues. Priority 1 is the highest
priority and that queue is processed first and completely by the device pool. Then the device pool moves
onto the processing queue with Priority 2. When the queue with Priority 2 is processed completely, the
device pool proceeds to processing queue with Priority 3, and so on. Automations are processed until all
automations are consumed from the specified automation queue.
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Nota:  This option is available only on the Run with queue automations tab.

Delete device pools
Delete a device pool comprising of unattended Bot Runners after your entity's automation goals are
achieved and the device pools are no longer required.
Ensure that you are logged in to the  as the administrator.
You can choose to delete your device pools in either of two ways:
• Delete one device pool
• Delete multiple or all device pools

If the device pool is being used for workload automation, you will not be allowed to delete it.
1. Navigate to Manage > Device pools.
2. Select the device pool(s) to delete.

Select the device pools to delete or select all device pools by selecting the Select All check box in the
header.

3. Hover over the Actions icon for the device pool.
4. Click Delete.

Confirm or cancel.

Attività correlate
View device pool details alla pagina 2637
As a Control Room user with device pool management privileges or as a device pool owner, you can view
device pool details to ensure the information provided is correct and if required customize as per your
automation requirement.
Crea pool di dispositivi alla pagina 2636
Create a device pool with a unique name and add Unattended Bot Runners to the device pool.

Pacchetti
Gli utenti con l'autorizzazione Gestisci pacchetto possono caricare e gestire i pacchetti. Automation
Anywhere offre la flessibilità necessaria per decidere quali pacchetti rendere disponibili ai Bot Creators per
la creazione di bots.
Users must have the appropriate administrative permission to view or manage action packages.

Visualizza pacchetti Un utente con l'autorizzazione Visualizza
pacchetti può visualizzare i pacchetti disponibili
per i Bot Creators. Vai alla pagina Bot > Pacchetti
per visualizzare Tutti i pacchetti.
The All packages page lists all the packages in the
Control Room that are available for Bot Creators.
Packages can have multiple versions.

Gestisci pacchetti Un utente con l'autorizzazione Gestisci pacchetti
può aggiungere nuovi pacchetti alla Control Room
e gestire le versioni dei pacchetti disponibili nella
Control Room.
Aggiungi pacchetti da Bot > Pacchetti >
Aggiungi pacchetto.
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Consente di gestire i pacchetti dalla pagina Bot
> Pacchetti > Tutti i pacchetti > Visualizza
pacchetto.

Imposta come
predefinito

Select a package and
set is as the default.
As soon as a package
is set to default, it is
the package that all Bot
Creators in the Control
Room use.

Disabilita Disabilita un pacchetto
in modo che gli utenti
non possano usarlo
per creare nuovi bots.
Bots that were created
using a package that is
disabled also fail to run.

Elimina Deleting a package
removes the actions
contained in the
package from the
Control Room for all
users.

Importante:  A
package cannot be
deleted if it is being
used by a bot.

Nota:  It is recommended that Bot Creators update bots to use the latest version of a package.

Updates to packages by Automation Anywhere are available in each release of Automation 360. Il
pacchetto aggiornato più recente può essere impostato sul pacchetto predefinito da utenti e amministratori
in possesso dell'autorizzazione Gestisci pacchetto.

Nota:  When you upgrade to Automation 360 v.24, the Apache log4j2 library is no longer bundled in
the command packages. Tuttavia, i precedenti packages di comandi di Automation 360 v.23 e versioni
precedenti potrebbero comunque includere la libreria log4j2. Per utilizzare i packages di comandi senza
libreria log4j2 inclusa, ti consigliamo di utilizzare i packages più recenti di Automation 360 v.24 per le tue
attività.

RBAC on packages
Based on the business requirements and expertise of developers, administrators can restrict package
access for a simplified developer experience, along with the capability to enforce access policies for custom
groups.
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Panoramica

The RBAC feature helps you to set access at the package level to restrict usage and execution of packages
to improve security. This feature can be applied to all package types, including custom packages where
you can control assigning and managing the packages to your users.
RBAC access to packages applies only to the task of creating bots. If a user role does not have access to a
particular package, these users cannot view the package on the Actions palette and therefore cannot use
it when creating bots. However, these users can run bots (created by a different user who has access to
the package) that uses the package.
• Each developer sees only the approved list of packages in their workspace.
• Some packages might be available for all users, while some are available only for certain groups.

The following image shows how RBAC can be set for user roles and groups:

Benefits of packages RBAC

• Centralized policy enforcement for secure, user-friendly developer access: Role-based access
to automation provides enhanced security, confidence, and ease of use for developers.

• Enterprise-wide access policy: Establish group-based package access with clear policies restricting
package access to all the users or users with specific roles.

• Access based on business needs: Create required access groups, expose group-appropriate library
of packages, and manage the phased rollout of package access.

• Simplified automation for citizen developers: Hide complex packages from the action palettes for
citizen developers so that they can focus on easy-to-complete automation.

• Automation reuse with compliance: Enable users to create utility bots from complex packages to
use as cloned bots in the a private workspace or inside public bots.

The following image lists the benefits of packages RBAC:
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User types

Administrator • Customizes packages so that they are accessible
to developers based on the developers'
expertise, skill, business group, and more.

• Creates custom groups and assign access per
group.

• Rolls out packages in a phased manner to
different types of developers.

• Provides better control over how packages are
made available to developers. Ad esempio:
• New developers can avoid causing security

risks as they do not have access to complex
packages.

• Advanced developers can get broader access
to packages.

An organization can enforce centralized control
over package access and best practices through
this feature.

Roles and permission required: Administrators
with the View Users and Roles basic
information and Manage packages permission.
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Bot developer • Gets a customized view of packages in their
workspace.

• Simplified (easy-to-use) packages are enabled
for Citizen Developers so that they can build
a basic functional task bot using actions and
packages available in their actions palette.

• Advanced developers can get access based on
the entitlements or privileges provided by the
administrator.

Roles and permission required: Users with the
View Users and Roles basic information and
Manage packages permission.

See the following video for an overview of how RBAC is configured:

Configure RBAC for packages
Restrict packages usage based on your business needs and roles for a secure and simplified developer
experience. An administrator can customize access to packages based on developers' expertise,
experience, and so on, while bot developers get a customized view of packages in their workspace based
on their expertise and needs.
You must be an administrator or a user with the View Users and Roles basic information and
Manage packages permission.

1. Accedi a Control Room.
2. Naviga su Gestisci > Pacchetti.
3. From the list of packages, search for the package for which you want to give access to the users.
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4. Click the selected package.

For example, when you click the Recorder package, the selected package window opens.
5. To allow specific users to use the package from the Bot editor, go to the Availability tab and click

Edit.
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6. On the Configure package availability page, choose one of the following options:
• All user: Select this option to allow the user to use the package while creating bots. By default,

this option is selected for all the packages.
• User with selected roles: Select this option if you want users with selected roles to access the

package and use it while creating bots.
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7. To configure access for specific users, perform these steps:
a) Select the User with selected roles option.
b) From the available roles, select the roles you want to assign.
c) Move the selected roles to the right panel.

This step enables you to define users who will have access to the package in the Bot editor.
d) Fai clic su Conferma.

The availability tab shows the selected roles for whom the specific package is now enabled.
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Packages RBAC for bot developer
As a Bot Creator (RPA developer) or Citizen Developer, you can create bots based on the packages that are
available to you.
You can use only those package-defined actions, triggers, variables, and customized packages for which
you have access. Your access to these packages are set by the administrator based on user roles. If you do
not have access to a package, you cannot view that package on the Actions palette.
RBAC on packages applies when you create or edit bots in your private workspace. You cannot run bots
with restricted packages directly. However, you can use a cloned bot as a sub bot in another main bot and
run this bot in a public or private workspace.
When a bot contains packages (or packages that you cannot access), keep in mind these considerations:
• You cannot perform these bot actions:

• Run a bot: Either a new bot or a checked-out bot with changes
• Check in a bot
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If you try to perform these actions, an error message is displayed that the bot contains packages that
are restricted.

• While editing variables, you cannot use variable property options related to restricted packages.
An error message is displayed that the variable is related to a package that is restricted.

• You cannot run a bot with triggers:
• From the Bot editor, when you run a bot with a trigger that contains a restricted package, see an

error message is displayed that the bot with triggers contains a restricted package.
• When a trigger event is configured for a user and a device, and the trigger event occurs on the

device, access to the bot package is verified. If the bot contains a restricted package, the bot fails,
and an audit log entry is recorded.

Add packages to the Control Room
Administrators can add packages to the Control Room for use by Bot Creators.
Ensure that you are logged in to the  as the administrator.
You can add a package from either Bot Store or another source.
To add a package from a source other than Bot Store, follow these steps:
1. Naviga su Gestisci > Pacchetti.
2. Click Add package.
3. Fai clic su Sfoglia.
4. Locate and select the package to add to the Control Room.

Packages are Java Archive (JAR) files that contain actions used to create bots.
5. Click Upload package.
6. On the Bots > Packages > Confirm package page, choose any of the following options:

• Accept, enable and set as default: Uploads and enables the selected package, and sets it to
the default package for the Control Room.

• Accept and enable: Uploads and enables the package, but the package is not set as the default
package. Bot Creators have to specifically select non-default packages to use them for creating
bots.

• Accept but disable: Uploads and disables the new package.

Choosing Reject stops the upload process.
To add a package from Bot Store, see the following video:

7. After installation, click Administration > Packages to verify that the package is added.
When you add or update a package in the Control Room, a notification is also sent through the
Notifications icon. This notification is sent to the Control Room users who have the View package
permission. For more information, see Add or update package alla pagina 2925 event notification.

Concetti correlati
Build and test a demo package and bot alla pagina 2417
This practical how to section demonstrates that creating, changing, and managing packages allow you to
customize actions and efficiently manage packages for all Control Room users.
Attività correlate
Manage Control Room packages alla pagina 2650
Manage packages in the Control Room by setting a package as default, disabling it, or deleting it.
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Manage Control Room packages
Manage packages in the Control Room by setting a package as default, disabling it, or deleting it.
Ensure that you are logged in to the  as the administrator.
To manage packages in the Control Room, users must have Manage package permission.
Package management actions apply to all users; however, the user can select specific package versions
within a bot.
1. Naviga su Gestisci > Pacchetti.
2. Hover over the Actions icon for the package.
3. Click View.
4. Choose any of the following options:

Opzione Descrizione

Imposta come predefinito Select a package and set is as the default. As
soon as a package is set to default, it is the
package that all Bot Creators in the Control Room
use.

Nota:  By default, new versions of packages
become the default version and will only be used
the first time that package is used in editing
a bot. If a bot already uses the package, it
continues to use an earlier version.

Disabilita Disabilita un pacchetto in modo che gli utenti
non possano usarlo per creare nuovi bots.
Bots creati utilizzando un pacchetto disabilitato
continueranno a funzionare.

Elimina Deleting a package removes the actions
contained in the package from the Control Room
for all users.
You can delete a package version if:
• A Control Room user with Manage package

permission added the package version.
However, you cannot delete any package
versions that were automatically installed by
the system, or through a Control Room new
installation or upgrade; you can only disable
them.

• The package version is not in Default status.
• The package has only one version, but its

status is Default.

Importante:  A package cannot be deleted if it is being used by a bot.

Concetti correlati
Pacchetti alla pagina 2640
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Gli utenti con l'autorizzazione Gestisci pacchetto possono caricare e gestire i pacchetti. Automation
Anywhere offre la flessibilità necessaria per decidere quali pacchetti rendere disponibili ai Bot Creators per
la creazione di bots.
Attività correlate
Add packages to the Control Room alla pagina 2649
Administrators can add packages to the Control Room for use by Bot Creators.

Aggiornamento dei bots alla versione predefinita del package
È possibile eseguire un aggiornamento in blocco dei bots esistenti nel repository della Control Room per
impostare la versione predefinita per qualsiasi package. Questa funzione consente un aggiornamento
rapido a una versione del package sicura e stabile tramite i bots.
• To update bots to the default package version, ensure you have the View packages permission and

the permission to edit bots.
Quando si avvia il processo di aggiornamento in blocco, questa azione aggiornerà i bots per cui si
dispone dell'autorizzazione di check-out e i bots tramite la versione non predefinita dello specifico
package.

• Verifica che i bots siano compatibili con l'attuale versione predefinita del package.
• Quando si aggiornano i bots alla versione predefinita del pacchetto, assicurati che i file bots non

vengano estratti fino al completamento del processo.
• Non disattivare il package quando è in corso il processo di aggiornamento in blocco.

Nota:
• L'aggiornamento dei bots in blocco per utilizzare la versione predefinita del package potrebbe influire

sulle prestazioni del repository della Control Room o su altre funzionalità della Control Room.
• When you perform bulk updates to existing bots to set the default versions for packages, ensure that

you wait until the bulk update process for one package is completed and only then start updating
another package.

1. Naviga su Gestisci > Pacchetti.
2. Cerca il package che desideri aggiornare tramite i bots.
3. Per impostare la versione predefinita del package in tutti i bots dello spazio di lavoro pubblico, fai clic

su Aggiorna i bot alla versione predefinita del pacchetto.
4. Nella finestra Aggiorna i bot alla versione predefinita del pacchetto, inserisci le seguenti

informazioni:
• Nome attività: Nome del processo avviato per l'aggiornamento in blocco della versione del

package in tutti i bots.
Nella pagina Log di audit, quando si seleziona Aggiorna pacchetto predefinito al bot
richiesto o Aggiorna pacchetto predefinito al bot completato per visualizzare i dettagli del
nome dell'elemento, il nome dell'attività viene visualizzato come nome della richiesta con il relativo
valore.

• Descrizione: Fornisci facoltativamente una descrizione di questa attività.
• Commenti per l'archiviazione: questo campo è già popolato con i dettagli della versione del

package in fase di aggiornamento.
Puoi inserire un commento significativo che sia d'aiuto per qualsiasi riferimento futuro. Questo
commento per l'archiviazione può essere visualizzato nella pagina Visualizza cronologia. Ad
esempio, naviga su Automazione > Pubblico > Cartella > TaskBot. Fai clic sui puntini di
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sospensione verticali e seleziona Visualizza cronologia TaskBot per visualizzare il messaggio di
estrazione in blocco per le nuove versioni dei bots create tramite l'aggiornamento in blocco.

Nota:  L'esecuzione del processo di aggiornamento in blocco non avrà alcun impatto sulle
pianificazioni o sulle esecuzioni dei bot esistenti. Per le pianificazioni, i bots con l'etichetta Produzione
continueranno a distribuire la versione di produzione e non la versione più aggiornata.

5. Fai clic su Aggiorna bot.
6. Fai clic su Sì, continua.

Il sistema inizia ad aggiornare tutti i bots nel repository della Control Room che utilizzano il package.
Se uno qualsiasi dei bots non sta utilizzando la versione predefinita dei packages, i bots saranno
aggiornati.

7. Naviga su Amministrazione > Log di audit.
8. Nella pagina Log di audit, effettua una ricerca per tipo di evento Aggiorna pacchetto predefinito.

Visualizza informazioni quali l'inizio del processo richiesto, i singoli bots in fase di aggiornamento
con la versione predefinita del package e il completamento del processo richiesto. È inoltre possibile
visualizzare i seguenti nomi di elementi nel log di audit per queste informazioni:
• Aggiorna pacchetto predefinito al bot richiesto
• Elenco di bots in fase di aggiornamento, ad esempio, Payrollprocess2022bot
• Aggiorna pacchetto predefinito al bot completato

9. Per visualizzare i dettagli di tutti i bots che sono stati aggiornati per utilizzare la versione predefinita
del package, copia l'ID richiesta dalla pagina Aggiorna pacchetto predefinito al bot richiesto.
Nella pagina Log di audit, effettua una ricerca per ID richiesta e inserisci il valore.
Ad esempio, puoi utilizzare d6adb0724340666e. Il log di audit visualizza tutti i bots che sono stati
aggiornati correttamente tramite il processo Aggiorna i bot alla versione predefinita. L'elenco
comprende anche i bots che non hanno superato il processo di aggiornamento.
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10. Per visualizzare i dettagli del nome di ciascun elemento nella pagina Log di audit, effettua le seguenti
operazioni:
a) Fai clic su Aggiorna pacchetto predefinito al bot richiesto e visualizza i seguenti dettagli:

• Dettagli evento: visualizza informazioni quali i dettagli dell'utente che ha inviato la richiesta,
i dettagli del dispositivo dell'utente, il numero ID della richiesta, la data e l'ora della richiesta
avviata e i dettagli della versione del package che verrà aggiornata su tutti i bots.

• Aggiorna dettagli del pacchetto predefinito: visualizza informazioni quali il nome della
richiesta, la versione modificata del package, il nome del package in fase di aggiornamento e
la versione del package attualmente in uso.

A seconda del package, tutti i bots che utilizzano il pacchetto selezionato saranno aggiornati uno
per uno.

b) Fai clic su qualsiasi bot per visualizzare le seguenti informazioni:
• Nome della richiesta: visualizza il nome della richiesta avviata.
• Percorso bot: visualizza il percorso del file o della cartella in cui si trova il bot.
• Nome pacchetto: visualizza il nome del package.
• Vecchia versione del pacchetto: visualizza la versione utilizzata in precedenza per il

package.
• Versione del pacchetto di destinazione: visualizza la versione a cui viene aggiornato il

package.
• Vecchia versione del bot: visualizza la versione precedente del bot.
• Nuova versione del bot: visualizza la versione corrente del bot in fase di aggiornamento.

Durante il processo di aggiornamento in blocco, alcuni bots potrebbero non riuscire ad aggiornare
la versione predefinita del package. Il bot non riuscito visualizza uno stato di operazione non
riuscita nella pagina Log di audit. Ad esempio, se i bots sono stati estratti durante il processo di
aggiornamento del package, l'aggiornamento della versione del pacchetto non viene eseguito per
questi bots, che quindi visualizzeranno uno stato di operazione non riuscita.

c) Fai clic su Aggiorna pacchetto predefinito al bot completato per visualizzare le informazioni
al termine del processo di aggiornamento in blocco:
• Numero di bots che sono stati aggiornati correttamente.
• Numero di bots il cui aggiornamento non è riuscito a causa di errori di compilazione o di bots

che sono stati estratti durante il processo di aggiornamento del package.
• Numero di bots saltati.

Se i bots utilizzano la stessa versione del package, verranno visualizzati come saltati durante il
processo di aggiornamento.

• Il numero del vecchio package e il numero della versione del package (predefinito) di
destinazione.

Per un esempio di questa procedura, vedi Example of updating default package version across bots alla pagina
2096.

Administrator settings
Control Room administrators manage settings related to the database, Credential Vault, users, roles, action
packages, licensing, and more.
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Attività correlate
Create a role alla pagina 2693
As an administrator, you can configure roles with permissions to access features and perform operations
such as create, edit, or delete a bot in the Control Room, and assign the role to a user.
Create a user alla pagina 2684
Crea un utente e assegna il suo ruolo specifico basato su licenza.
Installazione di licenze aggiuntive alla pagina 2794
Carica le nuove licenze in Automation Anywhere Control Room da distribuire agli utenti come richiesto.
Crea credenziali alla pagina 2842
Create a credential and add the required attributes.

Log di audit
View logs and details to record user activities.
Audit Log displays a read-only table of records of actions performed by users. These log records are
searchable and exportable. Audit logs include both Successful and Unsuccessful actions attempted.

Azioni

The following Audit log actions are enabled:

Nota:  Use your cursor to roll over the action button icons to identify specific functions.

Time filter Users select from preset time filters or configure
a custom time filter for log entries to view. The
default time filter setting is Last 24 hours.

Ricerca Search the records. Select additional search filter
criteria from the drop-down menu.

Suggerimento:  To search the exact phrase,
enclose the search phrase within double quotes (for
example, "Taylor-Finance-564").

Export checked items to CSV Export the data to a CSV file based on filters and or
selections.

Aggiorna Refresh and view the updated status.
Personalizza colonne Show or hide specific columns.
Visualizza To view details of a table entry, mouse over the

entry to expand and click Audit details.

Audit log table

View the following audit details in the table.

Table item Descrizione

Stato Shows action status.
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Table item Descrizione

Ora Shows the date and time of the action
performed.

Event Type Shows the type of action performed.

Nome elemento Shows the entity on which action was performed.

Event Started By Shows the user that performed the action.

Dispositivo sorgente Shows the device or machine name or IP
address that was used to perform the action.

Fonte Shows the component: Control Room, Enterprise
Client or API, from where the action originated
or was performed.

ID richiesta Shows the unique identity number assigned to a
specific set of user actions.

Bot life cycle audit logs

The entry shows the status of each stage of the bot life cycle.

Audit log entry Operazione riuscita Failure

Crea automazione Bot was sent to the control
room and was successfully
compiled.

Check if the Control Room is up
and running.

Bot Sent To Device Control Room deployed the bot
successfully on the specified
device.

Possible reasons for failure
entry include:
• Check if you have configured

the Node manager on
the corresponding device
correctly.

• Check for the app
Automation Anywhere Bot
Manager in Add Remove
Programs or in Control
Panel > Uninstall a
program. Try to reinstall by
uninstalling and downloading
the app again.

• Try to reinstall by
uninstalling and downloading
the app again from Device
Manager.

• Ensure the device auto log in
details are set correctly.
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Audit log entry Operazione riuscita Failure

Run bot Deployed The bot has started on the
specified device.

Possible reasons for failure
entry include:
• Check if you have configured

the Node manager on
the corresponding device
correctly.

• Check for app Automation
Anywhere Bot Manager in
Add Remove Programs
or in Control Panel >
Uninstall a program.

• Try to reinstall by
uninstalling and downloading
the app again from Device
Manager.

• Ensure device auto log in
details are set correctly.

Run bot finished Bot execution completed
successfully.

Possible reasons for failure
entry include:
• Check for the bot execution

progression in Activity In
progress.

• Check the code at the line
where activity log has been
paused for errors.

• If it has paused at a
message box, minimize
all windows and check if
the message box is in the
background.

Bot Runner Session Continued Control Room deploys the
TaskBots in a sequence for the
same RDP session.

Bot Runner Session Released When a task successfully
completes the execution.

Download file Downloading to the Control
Room.

Upload file Uploading a file to the Control
Room.

Bot Runner Session Control Room gets the RDP
session of Bot Runner machine.
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Syslog audit log

For on-premises deployments, the SysLog Configuration audit entry shows the Control Room server
status when adding, editing, or deleting the system configuration. The Syslog details shows these
attributes and their values:
• Syslog Server Hostname: Full qualified domain name (FQDN) or the IP address of the Syslog server

used to deliver the log reports
• Port: Port used by the remote Syslog server to receive incoming Syslog records
• Protocol: TCP or UDP
• Use Secure Connection: TLS encrypted channel used to send Syslog records to the remote Syslog

server

Audit log entry Stato User action SysLog details
shows these
attributes and
their values

Operazione riuscita Adds new values to an existing
server

• Syslog Server
Hostname

• Porta
• Protocollo
• Usa connessione

sicura

Ad esempio:
MyServer1.aa.com,
468, TCP,
Enabled

SysLog Configuration

Operazione riuscita Adds new values to multiple
servers

• Syslog Server
Hostname

• Porta
• Protocollo
• Usa connessione

sicura

Ad esempio:
MyServer1.aa.com,
468, TCP,
Enabled

MyServer2.aa.com,
333, TCP,
Disabled
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Audit log entry Stato User action SysLog details
shows these
attributes and
their values

Operazione riuscita Edits existing server • Syslog Server
Hostname

• Porta
• Protocollo
• Usa connessione

sicura

Ad esempio: Old
ValueMyServer1.aa.com,
468, TCP,
Enabled

New Value
MyServer123.aa.com,
514, UDP,
Disabled

Operazione riuscita Deletes existing server • Syslog Server
Hostname

• Porta
• Protocollo
• Usa connessione

sicura

Ad esempio:
MyServer1.aa.com,
468, TCP,
Enabled

SysLog Configuration Operazione non
riuscita

User attempted to save the
system configuration; however,
the Control Room was not able
to save the configuration.

For an unsuccessful
status, you can
use the results to
troubleshoot the
issue. Examples:
Invalid
Protocol, or
Could not
save SysLog
settings.
Invalid Host.

External key vault audit log

For cloud deployments, the External key vault configuration audit entry shows the type of external key
vault configured (if any). Automation Anywhere supports these external key vaults:
• AWS Secrets Manager
• Archivio chiave Azure
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• CyberArk Password Vault

Based on the type of external key vault configured, the external key vault configuration details shows
different attributes and their values.

Audit log entry Archivio chiave
esterno

User action Configuration
details shows
these attributes
and their values

AWS Secrets
Manager

Adds a new AWS Secrets
Manager when there was
previously no external key
vault.

• External key
vault value:
Changes from
no external
key vault to
AWS Secrets
Manager.

• AWS Secrets
Manager value
is Enabled

• Region value
is set to (for
example) us-
east-1

External key vault
configuration

CyberArk Adds a new CyberArk Password
Vault when there was
previously no external key
vault.

• External key
vault value:
Changes from
no external
key vault to
CyberArk.

• CyberArk value
is Enabled

• Vault URL is the
CyberArk AIM
server CCP API
URL and is set
to (for example)
https://
<hostname:port_num>/

• Application ID
is the CCP API
AppID and is set
to (for example)
AAEControlRoom
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Audit log entry Archivio chiave
esterno

User action Configuration
details shows
these attributes
and their values

Azure Key vault Adds a new Azure Key vault
when there was previously no
external key vault.

• External key
vault value:
Changes from
no external
key vault
to Azure Key
vault.

• Azure Key
vault value is
Enabled

• Vault URL is the
Azure Key Vault
URL and is set
to (for example)
https://
user-db-
vault.vault.azure.net/

• Client ID is the
(application)
ID of an App
Registration in
the tenant and
is set to (for
example)536145

• Tenant ID is the
Azure Active
Directory tenant
(directory) ID
and is set to (for
example)89D12L

External key vault
configuration

Change from AWS
Secrets Manager to
CyberArk

User changes from one
external key vault to another
type.

External key vault
value changes from
AWS Secrets
Manger to
CyberArk

Automation Anywhere Robotic Interface (AARI) Audit logs

The entry shows the status of events relating to requests, teams, scheduler, process setups, bot setups,
human tasks, and bot tasks that you have created, deleted, updated, submitted, or recovered.

Audit log entry Operazione riuscita

AARI Team • When a team is created by a user
• When a team is edited by a user
• When a team is deleted by a user
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Audit log entry Operazione riuscita

AARI Request • When a request is deleted by a user
• When a request is recycled by a user
• When a request is recovered by a user

AARI Human Task • When a task is edited by a user
• When a task is submitted by a user
• When a task is canceled by a user
• When a task is assigned by a user to another

user
• When a task is canceled (using a cancel type

of action by a user or by a bot (AARI Web
package))

AARI Bot Task When the process launched a bot task

AARI Process • When a process is created
• When a process is edited by a user

AARI Bot Setup • When a new bot is added to the bot setup
management

• When the bot setup management is modified
• When a bot is deleted by a user

Process Scheduler When the scheduler configuration is modified

Audit events list
Review the list of audit events to identify the type of audit entries that are logged in the Control Room for
Automation 360.

General audit entries

The following table shows a list of general audit entries and their descriptions (listed alphabetically):

Voci di audit Descrizione

Accept end user license agreement This action is logged when the user accepts the
license agreement.

Attiva automazione This action is logged when the user activates the
schedule.

Aggiungi credenziali This action is logged when the user creates
credentials.

Add Global value This action is logged when the user creates a
new global value.

Aggiungi armadietto This action is logged when the user creates the
locker.
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Voci di audit Descrizione

Aggiungi dipendenza manuale This action is logged when the user adds manual
dependency to a bot.

Add MFA token This action is logged when the user adds the MFA
(multi-factor authentication) token.

Assegna licenza This action is logged when the user creates
a user with a particular license (such as Bot
Creator or Bot Runner) and when the user
changes the license from Bot. This action is
logged when the user creates a user with a
particular license (such as Bot Creator or Bot
Runner) and when the user changes the license
from Bot Creator to Bot Runner and vice versa.

API-Key duration This action is logged when the user changes the
duration for how long a generated API-Key is
valid to authenticate users.

Errore di audit This action is logged when an audit error occurs.

Migrazione audit completata This action is logged when migration is
completed.

Migrazione audit avviata This action is logged when migration is started.

Audit unset activity type This action is logged when there is an unset
activity type.

Automation complete This action is logged when a schedule completes.

Auto-login credentials not set This action is logged when auto-login credentials
have not been set for the user.

BOT_AGENT_BULK_INSTALLATION This action is logged when the user changes the
option to generate a registration key to perform
bulk installation of Bot Agents on multiple
devices.

Bot runner session This action is logged when a Bot Runner session
occurs.

Bot saved This action is logged when a user saves a bot
or modifies a bot that is checked in to a Git
repository.

Bot sent to device This action is logged when a bot is sent to a
device.

Bot sent to device failed due to configuration
update

This action is logged when a bot fails to be
sent to a device because a device configuration
upgrade is in progress.

Bot validation setting This action is logged when a user sets the bot
validation setting.

Callback request This action is logged when a callback is
requested.

Callback URL validation failed This action is logged when the callback URL is
invalid and does not appear on the white list.
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Voci di audit Descrizione

Certificate authentication configuration create This action is logged when a user creates
certificate authentication settings.

Certificate authentication configuration update This action is logged when a user modifies the
certificate authentication configuration.

Certificate authentication TLS host configuration
create

This action is logged when a user creates
a certificate authentication TLS host server
configuration.

Certificate authentication TLS host configuration
reinstall

This action is logged when a user reinstalls
a certificate authentication TLS host server
configuration.

Certificate authentication TLS host configuration
update

This action is logged when a user modifies
a certificate authentication TLS host server
configuration.

Modifica impostazioni This action is logged when the user changes any
setting such as On to Off, or Off to On.

Archivia … This action is logged when a check in occurs.

Check in request This action is logged when a check in is
requested.

Estrai This action is logged when a checkout occurs.

Check out request This action is logged when a check out is
requested.

Accesso client This action is logged when a client logs in.

Clona This action is logged when a user clones an
object.

Cloud burst mode This action is logged when a cloud burst occurs.

Cloud-enabled provisioning success This action is logged when a cloud is successfully
provisioned.

Cloud-enabled provisioning failure This action is logged when cloud provisioning
fails.

Configure credential vault This action is logged when a user configures a
credential vault.

Connect credential vault This action is logged when a user connects a
credential vault.

Control Room configurations This action is logged when a user edits general
configuration settings to the Control Room.

Control Room upgrade available This action is logged when an upgrade to the
Control Room is available.

Control Room upgrade email notification This action is logged when an email has been
sent to indicate a successful upgrade to the
Control Room.

Control Room upgrade failure This action is logged when an upgrade to the
Control Room has failed.

© 2023 Automation Anywhere. All rights reserved.     2663



    Automation Anywhere - Gestisci

Voci di audit Descrizione

Control Room upgrade success This action is logged when an upgrade to the
Control Room has completed successfully.

Crea automazione This action is logged when the user creates a
new schedule or runs a bot with a queue in
workload management.

Crea bot This action is logged when the user creates a bot
for the first time.

Crea dominio This action is logged when the user creates a
new domain.

Crea bozza di coda This action is logged when the user saves the
work item as draft in workload management.

Create folder This action is logged when the user creates a
new folder.

Creare istanza di apprendimento This action is logged when the user creates a
new learning instance.

Crea pacchetto This action is logged when the user creates a
new package.

Crea credenziali proxy This action is logged when the user creates new
proxy credentials.

Crea coda This action is logged when the user creates a
new queue in workload management.

Creazione coda non riuscita This action is logged when a queue creation fails.

Crea ruolo This action is logged when the user creates a
new role.

Crea utente This action is logged when a new user is created.

Crea elemento di lavoro This action is logged when new work items are
added to a queue.

Creazione elemento di lavoro non riuscita This action is logged when new work items failed
to add to a queue.

Credential vault settings This action is logged when a user defines
credential vault settings.

Disattiva automazione This action is logged when the scheduled
automation is deactivated.

Elimina automazione This action is logged when the user deletes the
schedule.

Elimina bot This action is logged when the user deletes a
bot.

Elimina credenziali This action is logged when the user deletes
credentials.

Delete device This action is logged when the user deletes a
device.

Elimina file This action is logged when the user deletes a file.
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Voci di audit Descrizione

Elimina cartella This action is logged when the user deletes a
folder.

Delete Git settings This action is logged when the user deletes Git
repository settings in the Control Room.

Elimina valore globale This action is logged when the user deletes the
global value.

Elimina istanza di apprendimento This action is logged when the user deletes an
existing learning instance.

Elimina armadietto This action is logged when the user deletes a
locker.

Delete MFA token This action is logged when the user deletes the
MFA (multi-factor authentication) token.

Elimina credenziali proxy This action is logged when the user deletes proxy
credentials.

Elimina coda This action is logged when the user deletes the
queue in workload management.

Eliminazione coda non riuscita This action is logged when the user fails to delete
a queue.

Elimina ruolo This action is logged when the user deletes roles
from the system.

Delete tenant BLM clean up This action is logged when the Bot Lifecyle
Management (BLM) performs clean up for a
deleted tenant.

Elimina utente This action is logged when the user delete users
from the system.

Eliminare l’elemento di lavoro? This action is logged when the user deletes the
work item from the queue.

Eliminazione elemento di lavoro non riuscita This action is logged when the user fails to delete
work items in a queue.

Deployment automation This action is logged when a bot is deployed to
run.

Distribuzione in coda This action is logged when a deployment has
been queued to run.

Dispositivo acquisito dall’utente This action is logged when the device has been
acquired by the user.

Device configuration update initiated This action is logged when the user initiates the
device configuration update.

Device details updated This action is logged when the device details
have been successfully updated.

Device not available to acquire This action is logged when the device is
unavailable to be acquired by the user.
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Voci di audit Descrizione

Dispositivo registrato This action is logged when the user registers a
device.

Aggiornamento dispositivo configurato This action is logged when the user changes
the option to install or update the Bot Agent
software.

Device type update settings This action is logged when the settings of a
device type are updated.

Disabilita pacchetto This action is logged when the user disables a
package.

Disabilita utente This action is logged when the user disables
another user in the system.

Ripristino credenziali dominio This action is logged when the user resets or
reconnects to the Active Directory domain from
the settings page.

Scarica bot This action is logged when a user downloads a
bot.

Download bot finished This action is logged when the Bot Store
completes downloading a bot.

Scarica file This action is logged when a user downloads a
file.

Modifica bot This action is logged when the user renames a
bot.

Modifica dominio This action is logged when the user modifies a
domain.

Modifica istanza di apprendimento This action is logged when the user edits any
of the following settings of an existing learning
instance:
• Edits the name
• Edits or adds a description
• Uploads staging documents
• Adds new fields
• Edits new group setting
• Edits default validations groups setting

Modifica ruolo This action is logged when the user modifies a
role.

Edit role - folder permissions This action is logged when a user changes the
folder permissions of an existing role.

Edit settings This action is logged when the user modifies
settings.

Modifica utente This action is logged when the user modifies
another user.
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Voci di audit Descrizione

Backup Elasticsearch This action is logged when the user provides a
backup IP address in the Elasticsearch disaster
recovery backup cluster.

Elasticsearch delete index This action is logged when the user deletes an
index from the Elasticsearch.

Notifica via e-mail This action is logged when email notification
connection or authentication fails.

Impostazioni notifiche via e-mail This action is logged when the user modifies
email notification settings.

Empty pools This action is logged when there are empty pool
IDs.

Abilita pacchetto This action is logged when the user enables a
package.

Abilita utente This action is logged when the user enables
another user in the system.

Esegui automazione This action is logged when the user executes a
bot.

Esporta bot This action is logged when the user exports a
bot.

Esporta dominio This action is logged when the user exports any
of the domains from the IQ Bot application.

Esporta istanza di apprendimento This action is logged when the user exports
a learning instance ( .iqba file) through the
migration utility.

Export queue This action is logged when the user exports a
queue from workload management.

Export request This action is logged when the user generates an
export request.

Export to csv This action is logged when the user exports data
to a csv.

Failed to acquire user or device This action is logged when the device or user is
unavailable to be acquired.

Failsafe status updated This action is logged when a failsafe status has
been updated.

Impostazioni di caricamento file This action is logged when the user changes the
file upload settings to restrict or allow the upload
of executable files to a malicious file upload.

First Administrator settings This action is logged when a user configures the
first Administrator user in the Control Room.

Force unlock bot This action is logged when a user unlocks a bot.

Report GDPR This action is logged when a user enables GDPR
(General Data Protection Regulation) reporting.
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Voci di audit Descrizione

Genera chiave API This action is logged when an Admin user
generates an API key from the My Settings
page, which can be used to obtain an
authentication token. This audit entry shows the
generate API key status as either Successful or
Unsuccessful.

Git push This action is logged when the user synchronizes
information between the built-in Git repository
and the remote Git host.

Ripristino Git This action is logged when the user restores all
of their bots and associated dependent files from
the Git repository to a new database.

Interruzione ripristino Git This action is logged when the user aborts to
restore all of their bots and associated dependent
files from the Git repository to a new database.

Reimpostazione ripristino Git This action is logged when the user resets to
restore all of their bots and associated dependent
files from the Git repository to a new database.

Import bot This action is logged when the user imports a
bot.

Importa dominio This action is logged when the user imports any
new domains to IQ Bot. 

Importa istanza di apprendimento This action is logged when the user imports
a learning instance ( .iqba file) through the
migration utility.

Import queue This action is logged when the user imports a
queue into workload management.

Import request This action is logged when the user generates an
import request.

Installa licenza… This action is logged when the user installs or
changes the license from the license page.

Accesso all’indirizzo IP This action is logged when the IP address has
been accessed.

Migrazione licenza This action is logged when a license is migrated
to another user.

License mode change This action is logged when the user changes the
license mode.

Carica elementi di lavoro da file This action is logged when the user selects a
CSV or Excel file and uploads the work item in a
queue.

Log in banner settings This action is logged when an Admin configures
banner text to display on the login page of the
Control Room.

Migrazione completata This action is logged when a migration
completes.
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Voci di audit Descrizione

Migrazione avviata This action is logged when a migration begins.

Sposta automazione nella cronologia This action is logged when the user moves the
selected activity to the Historical page.

No access to pool This action is logged when a user has no access
to a device pool.

Override Global value This action is logged when users override a
global value with their own private value.

Impostazioni password This action is logged when an Admin configures
password settings for the Control Room.

Leggi credenziali This action is logged when the logged-in user
accesses the credentials of another user for
which they do have permission for because the
user is not a consumer for the credential or a
credential owner.

Leggi armadietto This action is logged when the logged-in user
accesses the locker of another user for which
they do not have permission because they
are not part of a locker as a member (owner,
manager, participant, or consumer).

Registra app This action is logged when the user configures IQ
Bot.

Ritira licenza This action is logged when the user changes the
license from Bot Runner to Bot Creator or Admin.

Release user license This action is logged when the user changes the
user license.

Rimuovi dipendenza manuale This action is logged when the manual
dependency is removed from a bot.

Rinomina cartella This action is logged when the user renames the
folder.

Invia nuovamente la verifica e-mail This action is logged when the email is resent for
verification.

Ripristina password This action is logged when the user resets the
password.

Revert checkout This action is logged when the user reverts a
previous check out action.

Rollback This action is logged when the user rolls back to
a previous version.

Esegui come utente in uso This action is logged when the user runs a bot as
the user using the bot.

Run as user invalid This action is logged when a user who tries to
run aand use the bot is invalid.

Esegui automazione This action is logged when the user runs an
automation.
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Voci di audit Descrizione

Save allowed IP addresses This action is logged when the allowed IP
addresses have been saved.

Programma avviato per errore This action is logged when the Control
Room services starts or the server is available
after more than 15 minutes of scheduled
deployment time.

Security Settings - External key Vault -
Configuration

For cloud deployments, this action is logged
when a user makes a change to the external
key vault configuration. Automation Anywhere
supports these external key vaults: AWS Secrets
Manager, Azure Key Vault, and CyberArk. This
audit entry shows the status as either Successful
or Unsuccessful.

Security Settings - Network settings This action is logged when the user changes the
configuration of the allowed IP address from
where the authentication is restricted.

Invia bot in produzione This action is logged when the user moves the
bot from staging to production.

Invia bot in staging This action is logged when the user moves the
bot from production to staging.

Invia e-mail This action is logged when an email is sent.

Invia istanza di apprendimento in produzione This action is logged when the user moves the
learning instance from staging to production.

Invia istanza di apprendimento in staging This action is logged when the user moves the
learning instance from production to staging.

Session timeout settings This action is logged when the settings of a
session timeout is reached.

Set default device This action is logged when the user sets the
default device.

Imposta credenziali dispositivo This action is logged when the user sets the
device credentials.

Set Git settings This action is logged when the user sets remote
Git repository settings in the Control Room.

Sync license This action is logged when a license is synced.

SysLog Configuration For on-premises deployments, this action is
logged when a user adds, edits, or deletes Syslog
server configuration. This audit entry shows the
Control Room server recording the status as
either Successful or Unsuccessful.

Temporary devices cleanup job This action is logged when the temporary device
runs its cleanup job.

Verifica la connessione proxy This action is logged when proxy connectivity is
tested.
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Voci di audit Descrizione

Timeout This action is logged when an operation times
out.

Addestra bot This action is logged when the user creates a
training bot.

Trasferisci proprietà credenziali… This action is logged when the locker admin
transfers the ownership of the credentials.

Trigger bot run This action is logged when a bot runs due to a
trigger.

Trigger bot run fail This action is logged when a bot fails to run due
to a trigger.

Trigger delete This action is logged when a trigger is deleted.

Eliminazione trigger non riuscita This action is logged when the deletion of a
trigger fails.

Trusted CA key store update This action is logged when a user modifies
the trusted CA key store for certificate
authentication.

Unable to send bot device This action is logged when a bot fails to be sent
to a device.

Undo checkout This action is logged when the user reverses a
check out.

Unlock credential vault This action is logged when the user unlocks the
credential vault.

Unset default device This action is logged when the user changes the
default device.

Aggiorna registrazione app This action is logged when the IQ Bot URL is
updated in the settings page.

Aggiorna automazione This action is logged when the user edits the
schedule automation.

Update callback URL failed This action is logged when the callback URL list
has failed to update.

Update callback URL successful This action is logged when the callback URL list
has been updated successfully.

Aggiorna credenziale This action is logged when the user modifies the
credentials.

Update device auto download packages This action is logged when the device updates its
auto download packages settings.

Update device credentials This action is logged when the device updates its
credentials.

Update device general settings This action is logged when the device updates its
general settings.

Update device log settings This action is logged when the device updates its
log settings.
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Voci di audit Descrizione

Update device RDP settings This action is logged when the device updates its
RDP (Remote Desktop Protocol) settings.

Update device resolution settings This action is logged when the device updates its
resolution settings.

Update Git settings This action is logged when the user updates
remote Git repository settings in the Control
Room.

Update Global value This action is logged when the user updates an
existing public global value.

Aggiorna armadietto This action is logged when the user modifies the
lockers.

Update MFA role This action is logged when the user modifies the
MFA (multi-factor authentication) role.

Update MFA settings This action is logged when the user modifies the
MFA (multi-factor authentication) settings.

Update MFA token This action is logged when the user modifies the
MFA (multi-factor authentication) token.

Update MFA user This action is logged when the user modifies the
two-factor authentication for a user.

Aggiorna pacchetto This action is logged when the user updates an
existing package.

Update package settings This action is logged when the user updates any
package settings.

Aggiorna credenziali proxy This action is logged when the user updates
existing proxy credentials.

Aggiorna coda This action is logged when the user updates the
existing queue (for example, adding new work
items to the same queue).

Aggiornamento coda non riuscito This action is logged when the user fails to
update the existing queue (for example, adding
new work items to the same queue).

Aggiorna impostazioni This action is logged when the user updates any
setting in Control Room.

Update temporary devices auto delete settings This action is logged when the temporary device
updates its auto delete settings.

Aggiorna elemento di lavoro This action is logged when the user edits a work
item.

Aggiornamento elemento di lavoro non riuscito This action is logged when work items fail to
update.

UPDATE_DEVICE_ADVANCED_OPTIONS_SETTINGSThis action is logged when the user changes
the device environment settings such as: global
cache location, auto-login timeout duration, and
so on.
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Voci di audit Descrizione

UPDATE_DEVICE_THRESHOLD_SETTINGS This action is logged when the user changes
enables or disables the threshold settings such
as: CPU utilization, device memory threshold
values, and so on.

UPDATE_DEVICE_LOG_SETTINGS This action is logged when the user changes the
log collection settings such as: log collection, log
size, and so on.

UPDATE_GLOBAL_AUTO_LOGIN_SETTINGS This action is logged when the user changes
the auto-login settings in the Control Room to
either create user sessions, or reuse existing user
sessions to reduce the bot startup time.

Carica This action is logged when a user imports a file.

Carica bot This action is logged when a user uploads a bot.

Carica documento This action is logged when a user uploads a
document.

Carica file This action is logged when a user uploads a file.

Carica pacchetto This action is logged when the user uploads a
package.

Carica file elementi di lavoro This action is logged when the user updates a
queue and adds work items.

User Authentication configuration This action is logged when the user changes
the Control Room database or SAML user
authentication configuration.

Accesso multiplo utente This action is logged when the user logs in to
the Control Room from different browsers with
the same username.

Accesso utente This action is logged when the user logs in to
the Control Room.

Disconnessione utente This action is logged when the user logs out of
the Control Room.

Convalida istanza di apprendimento This action is logged when the user validates
(either corrects the document and saves it or
invalidates the document) a document in the
validator of a learning instance.

Impostazioni controllo versioni This action is logged when the user updates any
version control settings.

Connessione proxy websocket non riuscita This action is logged when the websocket proxy
connection fails.

AD audit entries

The following table shows the list of AD audit entries and their descriptions (listed alphabetically):
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Voci di audit Descrizione

Mappatura del gruppo AD creata This action is logged when the user creates an
AD role mapping.

Mappatura del gruppo AD eliminata This action is logged when the user deletes an
AD role mapping.

Mappatura del gruppo AD aggiornata This action is logged when the user updates an
Active Directory role mapping.

AD sync role empty This action is logged when an Active Directory
role assigned with sync operations is empty.

AD sync role conflict This action is logged when an Active Directory
role assigned with sync operations is in conflict
with another role.

Sistema del ruolo per la sincronizzazione AD
assegnato

This action is logged when new Active Directory
roles are assigned with sync operations.

Sistema del ruolo per la sincronizzazione AD
eliminato

This action is logged when Active Directory roles
are deleted with sync operations.

Sistema del ruolo per la sincronizzazione AD
aggiornato

This action is logged when Active Directory roles
are updated with sync operations.

AD sync user count This action is logged when the Active Directory
user counts are synced.

AD sync user deleted This action is logged when the Active Directory
synced users are deleted.

AD sync user out of license This action is logged when the Active Directory
synced users run out of available licenses.

Bot Insight audit entries

The following table shows the list of Bot Insight audit entries and their descriptions (listed alphabetically):

Voci di audit Descrizione

Bot Insight add user dashboard This action is logged when a new user dashboard
is added to Bot Insight.

Bot Insight BLM dashboard export This action is logged when a user exports a BLM
(Bot Lifecycle Management) dashboard from Bot
Insight.

Bot Insight BLM dashboard import This action is logged when a user imports a BLM
(Bot Lifecycle Management) dashboard into Bot
Insight.

Bot Insight create dashboard This action is logged when a user creates a
dashboard in Bot Insight.

Bot Insight copy dashboard This action is logged when a user copies a
dashboard in Bot Insight.

Bot Insight delete dashboard This action is logged when a user deletes a
dashboard from Bot Insight.
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Voci di audit Descrizione

Bot Insight delete user dashboard This action is logged when a user dashboard is
deleted from Bot Insight.

Bot Insight end task This action is logged when a task ends in Bot
Insight.

Bot Insight get task data This action is logged when task data is retrieved
in Bot Insight.

Bot Insight get user dashboards This action is logged when user dashboards are
retrieved in Bot Insight.

Bot Insight load dashboard This action is logged when a user loads a
dashboard in Bot Insight.

Bot Insight operations This action is logged when operations occur in
Bot Insight.

Bot Insight publish dashboard This action is logged when a user publishes a
dashboard in Bot Insight.

Bot Insight registers dashboard This action is logged when a user registers a
dashboard in Bot Insight.

Bot Insight run data This action is logged when data runs in Bot
Insight.

Bot Insight save dashboard This action is logged when a user saves a
dashboard in Bot Insight.

Bot Insight search dashboard This action is logged when a user searches a
dashboard in Bot Insight.

Bot Insight start task This action is logged when a task starts in Bot
Insight.

Bot Insight update dashboard This action is logged when a user updates a
dashboard in Bot Insight.

Bot Insight profile update This action is logged when a user updates a data
profile in Bot Insight.

Bot Store audit entries

The following table shows the list of Bot Store audit entries and their descriptions (listed alphabetically):

Voci di audit Descrizione

Bot Store add to My bots This action is logged when a user adds a bot to
their My bots.

Bot Store clean up This action is logged when clean up is performed
for a deleted tenant.

Bot Store download This action is logged when a user starts to
download a bot from the Bot Store.

Bot Store log in This action is logged when a user logs in to the
Bot Store.
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Voci di audit Descrizione

Bot Store submit bots This action is logged when a user submits bots to
the Bot Store.

Device pool audit entries

The following table shows the list of device pool audit entries and their descriptions (listed alphabetically):

Voci di audit Descrizione

Pool di dispositivi creato This action is logged when the user successfully
creates a new device pool.

Creazione pool di dispositivi non riuscita This action is logged when the user fails to create
a device pool.

Pool di dispositivi eliminato This action is logged when the user successfully
deletes a device pool.

Eliminazione pool di dispositivi non riuscita This action is logged when the user fails to delete
a device pool.

Aggiornamento pool di dispositivi non riuscito This action is logged when the user fails to
update an existing device pool.

Pool di dispositivi aggiornato This action is logged when the user edits an
existing device pool (for example, add a new
device or add a new customer role).

Device update audit entries

The following table shows the list of device update audit entries and their descriptions (listed
alphabetically):

Voci di audit Descrizione

Aggiornamento dispositivo confermato This action is logged when the device update has
been acknowledged.

L’aggiornamento del dispositivo è già in corso This action is logged when the device update is
already in progress.

Aggiornamento dispositivo completato This action is logged when the device update has
completed.

Device update disconnected This action is logged when the device update has
been disconnected.

Aggiornamento dispositivo scaricato This action is logged when the device update has
been downloaded.

Device update failed and max retry reached This action is logged when the device update has
failed after the maxiumum number of retries has
been reached.
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Voci di audit Descrizione

Device update failed and max retry reset
reached

This action is logged when the device update
has failed but device will continue to retry the
update.

Aggiornamento dispositivo inizializzato This action is logged when the user initiates the
device update.

Device update settings This action is logged when the settings of a
device are updated.

Aggiornamento dispositivo avviato This action is logged when the device update has
started.

Device update unavailable This action is logged when the device update has
already occurred and been updated.

Aggiornamento dispositivo non riuscito This action is logged when the device update has
been unsuccessful.

Aggiornamento dispositivo in attesa delle
distribuzioni per il completamento

This action is logged when the device update is
waiting for deployments to complete.

Discovery bot audit entries

The following table shows the list of Discovery bot audit entries and their descriptions (listed
alphabetically):

Voci di audit Descrizione

Discovery bot cancel recording This action is logged when the discovery bot
successfully cancels a recording.

Discovery bot convert to bot This action is logged when the discovery bot
successfully converts to a bot.

Discovery bot create aggregated recording This action is logged when the discovery bot
successfully creates a new aggregated recording.

Discovery bot create opportunity This action is logged when the discovery bot
successfully creates a new opportunity.

Discovery bot create process This action is logged when the discovery bot
successfully creates a new process.

Discovery bot create process assignment This action is logged when the discovery bot
successfully creates a new process assignment.

Discovery bot create project This action is logged when the discovery bot
successfully creates a new project.

Discovery bot create recording This action is logged when the discovery bot
successfully creates a new recording.

Discovery bot create recording step This action is logged when the discovery bot
successfully creates a new recording step.

Discovery bot create recording step metadata This action is logged when the discovery
bot successfully creates metadata for a new
recording step.

© 2023 Automation Anywhere. All rights reserved.     2677



    Automation Anywhere - Gestisci

Voci di audit Descrizione

Discovery bot delete aggregated recording This action is logged when the discovery bot
sucessfully deletes an aggregated recording.

Discovery bot delete opportunity This action is logged when the discovery bot
successfully deletes an opportunity.

Discovery bot delete process This action is logged when the discovery bot
successfully deletes a process.

Discovery bot delete process assignment This action is logged when the discovery bot
successfully deletes a process assignment.

Discovery bot delete project This action is logged when the discovery bot
successfully deletes a project.

Discovery bot delete recording This action is logged when the discovery bot
successfully deletes a recording.

Discovery bot delete recording step This action is logged when the discovery bot
successfully deletes a recording step.

Discovery bot delete recording step metadata This action is logged when the discovery bot
successfully deletes metadata for a recording
step.

Discovery bot export opportunity This action is logged when the discovery bot
exports an opportunity.

Discovery bot migrate opportunity This action is logged when the discovery bot
migrates an opportunity.

Discovery bot update aggregated recording This action is logged when the discovery bot
edits an existing aggregated recording.

Discovery bot update aggregated recording json This action is logged when the discovery bot
edits an existing aggregated recording using
json.

Discovery bot update opportunity This action is logged when the discovery bot
edits an existing opportunity.

Discovery bot update process This action is logged when the discovery bot
edits an existing process.

Discovery bot update process assignment This action is logged when the discovery bot
edits an existing process assignment.

Discovery bot update project This action is logged when the discovery bot
edits an existing project.

Discovery bot update recording This action is logged when the discovery bot
edits an existing recording.

Discovery bot update recording step This action is logged when the discovery bot
edits an existing recording step.

Discovery bot update recording step metadata This action is logged when the discovery bot
edits metadata for an existing recording step.
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Run bot audit entries

The following table shows the list of run bot audit entries and their descriptions (listed alphabetically):

Voci di audit Descrizione

Esecuzione bot disconnessa This action is logged when a user disconnects a
running bot.

Esecuzione bot completata This action is logged when a running bot finishes.

Esecuzione bot in pausa This action is logged when a user pauses a
running bot.

Run bot pre process failed This action is logged when the pre-process to run
the bot fails.

Esecuzione bot riconnessa This action is logged when a user re-connects a
running bot.

Esecuzione bot riavviata This action is logged when a previously paused
bot resumes to run.

Esecuzione bot sospesa This action is logged when a user stops a running
bot.

Run bot local audit entries

The following table shows the list of run bot local audit entries and their descriptions (listed alphabetically):

Voci di audit Descrizione

Run bot local hotkey finished This action is logged when a running bot for a
local hotkey finishes.

Run bot local hotkey paused This action is logged when a running bot for a
local hotkey pauses.

Run bot local hotkey resumed This action is logged when a running bot for a
local hotkey resumes.

Run bot local hotkey started This action is logged when a running bot for a
local hotkey starts.

Run bot local hotkey stopped This action is logged when a running bot for a
local hotkey stops.

Run bot local hotkey suspended This action is logged when a running bot for a
local hotkey is suspended.

Run bot local schedule finished This action is logged when a running bot for a
local schedule finishes.

Run bot local schedule paused This action is logged when a running bot for a
local schedule pauses.

Run bot local schedule resumed This action is logged when a running bot for a
local schedule resumes.
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Voci di audit Descrizione

Run bot local schedule started This action is logged when a running bot for a
local schedule starts.

Run bot local schedule stopped This action is logged when a running bot for a
local schedule stops.

Run bot local schedule suspended This action is logged when a running bot for a
local schedule is suspended.

Run bot local triggger finished This action is logged when a running bot for a
local triggger finishes.

Run bot local triggger paused This action is logged when a running bot for a
local triggger pauses.

Run bot local triggger resumed This action is logged when a running bot for a
local triggger resumes.

Run bot local triggger started This action is logged when a running bot for a
local triggger starts.

Run bot local triggger stopped This action is logged when a running bot for a
local triggger stops.

Run bot local triggger suspended This action is logged when a running bot for a
local triggger is suspended.

Run logic local audit entries

The following table shows the list of run logic local audit entries and their descriptions (listed
alphabetically):

Voci di audit Descrizione

Run logic local client finished This action is logged when running logic for a
local client finishes.

Run logic local client paused This action is logged when running logic for a
local client pauses.

Run logic local client resumed This action is logged when running logic for a
local client resumes.

Run logic local client started This action is logged when running logic for a
local client starts.

Run logic local client stopped This action is logged when running logic for a
local client stops.

Run logic local client suspended This action is logged when running logic for a
local client is suspended.

Run workflow local audit entries

The following table shows the list of run workflow local audit entries and their descriptions (listed
alphabetically):
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Voci di audit Descrizione

Run workflow local client finished This action is logged when running a workflow
for a local client finishes.

Run workflow local client started This action is logged when running a workflow
for a local client starts.

Run workflow local client stopped This action is logged when running a workflow
for a local client stops.

Run workflow local schedule finished This action is logged when running a workflow
for a local schedule finishes.

Run workflow local schedule started This action is logged when running a workflow
for a local schedule starts.

Run workflow local schedule stopped This action is logged when running a workflow
for a local schedule stops.

Run workflow local trigger finished This action is logged when running a workflow
for a local trigger finishes.

Run workflow local trigger started This action is logged when running a workflow
for a local trigger starts.

Run workflow local trigger stopped This action is logged when running a workflow
for a local trigger stops.

Schedule bot audit entries

The following table shows the list of schedule bot audit entries and their descriptions (listed
alphabetically):

Voci di audit Descrizione

Programmazione bot disconnessa This action is logged when a scheduled bot is
disconnected.

Programmazione bot completata This action is logged when a scheduled bot ends.

Programmazione bot in pausa This action is logged when a scheduled bot
pauses.

Programmazione bot riconnessa This action is logged when a scheduled bot is
reconnected.

Programmazione bot riavviata This action is logged when a scheduled bot
resumes.

Programmazione bot sospesa This action is logged when a scheduled bot stops.

Export audit data to CSV
Export Control Room log related data to a CSV file.
• You must have the View_user permission to export the basic information about other users to the CSV

file.
• The source and the target Control Room instances must be running the same version.
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• The source and the target Control Room instances must be of the same setup type: SSO with SSO, AD
with AD, and non-AD with non-AD.

You can export selected, filtered, or all audit log data to a CSV file by using the following options:
• Export checked items
• Export filtered items
• Export all items

1. Naviga su Amministrazione > Log di audit.
A list of all the logs is displayed.

2. Click the Export items to CSV drop-down

menu.
3. Click one of the following required sub-menus:

• Export checked items: Exports only the selected records.

Nota:  You must select items to use this option.

• Export filtered items: Exports only records that are available after applying filters like Status, Item
name, Event type, and so on.

• Export all items: Exports all the available records.

Nota:  puoi esportare massimo 100.000 record alla volta.

The CSV file is exported and downloaded to your local system based on the selected option.

Nota:
• If there is large number of audit logs to export, a message is displayed, informing that the export

function is started and exported CSV file is available in the Activity > Historical page. Per
ulteriori informazioni, consulta Download exported CSV file alla pagina 2682.

• Il tempo necessario per esportare i dati in un file CSV può variare in base al numero di record. Se
il tempo necessario per esportare i dati è superiore a 2 secondi, viene visualizzato un messaggio. Il
file CSV generato sarà disponibile per il download.

Consulta anche Syslog server integration alla pagina 2742.

Download exported CSV file
When there is large number of audit log data to export, the export function starts and exported CSV file is
available in the Activity > Historical page.
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To download the exported CSV file,
1. Navigate to the Activity > Historical page and search for exported audit log by using the Audit-

Export

keyword.
A list of all the exported audit log files is displayed.

2. Click the required item name hyperlink to view the audit log details.

3. Fai clic su Scarica file zip esportato.

The CSV file is downloaded to your local system as a zip file.

Utenti
As an administrator, you can create, view, edit, delete, and enable or disable a user. Creating users steps
vary depending on whether the user is a non-Active Directory, Active Directory, or single sign-on (SSO)
user from an IdP server.

Column actions

• Click a column header to sort by ascending or descending order.
• Drag and drop a column header to move the column left or right.
• Drag the end of a column corner to re-size.

Individual user actions

Perform the following tasks on an individual user:

Visualizza Opens the View user page in read-only mode.
It shows user details, assigned roles, and general
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details such as Last Modified, Modified by,
Object type, and User type.
You can edit a user detail and enable or disable a
user.

Modifica Opens the Edit user page in write mode. You
can update user details, device login credentials,
assigned roles, and device licenses.
When you edit a user, an email is sent notifying the
user if SMTP is enabled.
Only user devices with the Bot Agent installed at
the system level are available for selection as the
default device.

Enable︱Disable Activates or deactivates the user. When you enable
or disable a user, an email is sent notifying the user
if SMTP is enabled.

Elimina Deletes the user. This is useful when users leave
an organization or move to another role. This frees
both the device to which the user was attached and
the allocated license.
When you delete a user, an email is sent notifying
the user if SMTP is enabled.

Nota:  Before removing a user from the active RPA,
administrators should make certain all unfinished
development of bots are checked-in.

Table-level actions

Perform the following tasks by hovering the mouse over the icons at the top-right of the User table. These
actions can be performed only at a table-level and not on individual items.

Create role with checked items Adds a role and assigns the selected users.
Create a user alla pagina 2684

Delete checked items Deletes the selected users. You cannot delete a
user who is currently logged in.

Esporta in CSV Exports the selected users in the table in CSV
format.

Aggiorna Refreshes the table and reflects the latest data.
Personalizza colonne Select the columns to show or hide in the table.

Create a user
Crea un utente e assegna il suo ruolo specifico basato su licenza.
Ensure that you are logged in to the  as the administrator.
1. Accedi ad Amministrazione > Utenti.
2. Fai clic su Crea utente.
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3. Enter the required general details as follows:

Campo Valore

Abilita utente Select for the user to be activated and log in
immediately.

Nota:  If this option is not selected, user will be
in the inactive state and cannot log in.

Nome utente Inserisci un nome utente univoco.

Descrizione Inserisci una descrizione per l'utente.

Nome Immetti il nome dell'utente.

Nota:  The number of characters allowed in the
First name field is 50.

Cognome Immetti il cognome dell'utente.

Nota:  The number of characters allowed in the
Last name field is 50.

Password Enter and confirm a password for the user.
Ensure that the password follows all the
necessary password policies.

E-mail Inserisci e conferma l'indirizzo e-mail dell'utente.
If SMTP is enabled, an email is sent to this
address to confirm the account. All important
Control Room notifications are sent to this email
address.

4. Select the required role from the list of Available roles.
5. Click the right arrow (→) to add your selection.
6. Select Allow to allow multiple sessions.

You must be Control Room administrator to set a user as a multi-login service user. It is possible to set
a user as a multi-login user either in the UI or API, however a user may only access multiple sessions
through the API.

7. Assign a device license to the user.

Nota:  When you logged in as administrator, you cannot allocate any device license to the user and
None option is selected by default.

Licenza Privilegi

Nessuno The user can access the Control Room only.

Bot Creator- Development license Enables user to create and run bots. Auto login is
enabled by default.
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Licenza Privilegi

Bot Runner non assistito - Licenza di
runtime

Gli utenti con questa licenza possono eseguire
tutte le attività di automazione che gli utenti
assistiti possono eseguire. Inoltre, questa licenza
può essere utilizzata anche per la distribuzione
della Control Room, la programmazione
centralizzata e la distribuzione basata su API.

Bot Runner assistito - Licenza di runtime Gli utenti con questa licenza possono eseguire
bots sui loro dispositivi e utilizzare qualsiasi
trigger di eventi associato al loro account utente
o ruolo. Tuttavia, questi utenti non possono
programmare bots.

Citizen Developer - Licenza di sviluppo Gli utenti con questa licenza possono creare ed
eseguire i bots (anche bots con trigger) sui loro
dispositivi.

L'opzione Ignora il disclaimer di limitazione della responsabilità viene abilitata
automaticamente per consentire all'utente di eseguire bots su un dispositivo senza dover accettare
manualmente una dichiarazione di non responsabilità.
Dopo aver selezionato una licenza per il dispositivo, le Credenziali di accesso del dispositivo sono
abilitate. Se disponi dell'autorizzazione Attesta credenziali dispositivo, puoi scegliere di attestare
le credenziali del dispositivo per questo utente per bypassare la convalida delle credenziali quando si
distribuiscono i bots. L'utente Bot Runner deve avere una sessione utente sbloccata e attiva.

Nota:  Questo funziona solo se l'impostazione di accesso automatico Riutilizza una sessione
esistente è selezionata nella Control Room dall'amministratore.

8. Fai clic su Crea utente.

Watch the following video on how to create a user in Automation 360:

Creazione di un utente Active Directory
Puoi aggiungere l'utente Active Directory selezionando il dominio AD, fornendo dettagli sull'ambiente AD e
assegnando un ruolo e una licenza dispositivo.
Ensure that you are logged in to the  as the administrator.

Nota:  Before removing a user, administrators should make certain all unfinished development of bots are
checked-in.

1. Accedi ad Amministrazione > Utenti.
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2. Nella sezione Dettagli generali, inserire le seguenti informazioni:
a) Abilita utente: seleziona questa opzione in modo che l'utente possa accedere immediatamente.
b) Dominio Active Directory: seleziona il nome Active Directory per l'utente.

L'elenco mostra tutti i domini disponibili nel controller di dominio di Active Directory.

Nota:  Control Room Active Directory supporta un ambiente multidominio a foresta singola.

c) Nome utente: fai clic su CONTROLLA IL NOME IN ACTIVE DIRECTORY.
• Se il nome utente è presente nel database Active Directory, i campi Nome, Cognome, E-

mail e Conferma e-mail vengono compilati automaticamente.
Se i dati non vengono compilati automaticamente, inserisci i dettagli nei campi.

Nota:  Nel nome utente puoi utilizzare caratteri riservati, come la virgola (,).

• Se il nome utente non è presente nel database Active Directory, viene visualizzato un
messaggio di errore. Per risolvere il problema, contatta l'amministratore di rete.

Se il protocollo SMTP è abilitato, all'utente viene inviata un'e-mail a questo indirizzo per
confermare l'account. Tutte le notifiche importanti della Control Room verranno inviate a questo
indirizzo e-mail. Puoi utilizzare il carattere "@" per accettare i nomi utente in formato e-mail.

Nota:  Per supportare SSO su SAML, il nome principale dell'utente (come in Azure Active
Directory) deve corrispondere al nome utente corrispondente nella control room.

3. Select the required role from the list of Available roles.
4. Assign a device license to the user.

Nota:  When you logged in as administrator, you cannot allocate any device license to the user and
None option is selected by default.

Licenza Privilegi

Nessuno The user can access the Control Room only.

Bot Creator- Development license Enables user to create and run bots. Auto login is
enabled by default.

Bot Runner non assistito - Licenza di
runtime

Gli utenti con questa licenza possono eseguire
tutte le attività di automazione che gli utenti
assistiti possono eseguire. Inoltre, questa licenza
può essere utilizzata anche per la distribuzione
della Control Room, la programmazione
centralizzata e la distribuzione basata su API.

Bot Runner assistito - Licenza di runtime Gli utenti con questa licenza possono eseguire
bots sui loro dispositivi e utilizzare qualsiasi
trigger di eventi associato al loro account utente
o ruolo. Tuttavia, questi utenti non possono
programmare bots.
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Licenza Privilegi

Citizen Developer - Licenza di sviluppo Gli utenti con questa licenza possono creare ed
eseguire i bots (anche bots con trigger) sui loro
dispositivi.

L'opzione Ignora il disclaimer di limitazione della responsabilità viene abilitata
automaticamente per consentire all'utente di eseguire bots su un dispositivo senza dover accettare
manualmente una dichiarazione di non responsabilità.
Dopo aver selezionato una licenza per il dispositivo, le Credenziali di accesso del dispositivo sono
abilitate. Se disponi dell'autorizzazione Attesta credenziali dispositivo, puoi scegliere di attestare
le credenziali del dispositivo per questo utente per bypassare la convalida delle credenziali quando si
distribuiscono i bots. L'utente Bot Runner deve avere una sessione utente sbloccata e attiva.

Nota:  Questo funziona solo se l'impostazione di accesso automatico Riutilizza una sessione
esistente è selezionata nella Control Room dall'amministratore.

5. Fai clic su Crea utente.

Utente Citizen Developer
A Citizen Developer is a business user who can create and run bots, and share these automated tasks with
peers. Citizen Developer is typically not a technical expert but a specialist such as a marketing analyst, HR
manager, and accounts manager.

Panoramica

Users with bot creation capability can create, edit, run, or schedule bots on their device. While users with
bot execution capability can access a public folder to run or schedule published bots. Citizen Developer
users combine these capabilities to create bots, access the public folder, and clone published bots and run
them on their devices.

Capabilities

In an organization, an administrator typically creates the Citizen Developer role with the necessary bot
permissions and specifies the database or folder access. The administrator assigns this role to existing or
new users and allocates the Citizen Developer license to them.
A Citizen Developer user can then perform the following tasks:
• Create bots and run them on their devices.
• Add and delete event triggers for bots on their devices.

Citizen developer user can create a private event trigger. However, the associated bot must be checked
in to a public folder for other citizen developer or Bot Runner users to access that event trigger.

• Publish their bots to the public folder where other Citizen Developer users can access them.
• Access the public folder and clone published bots (including bots with triggers).
• Customize cloned bots and run them on their devices.
• Check in bots from their devices to the public folder.
• Check out bots from the public folder.

The following image illustrates the capabilities of a Citizen Developer user:
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Esempio

Consider a scenario where an organization has Marketing and Finance teams. The administrator creates
the following two Citizen Developer roles:
• CD (Marketing): provides access to all Marketing team folders
• CD (Finance): provides access to all Finance team folders

The administrator then assigns the Citizen Developer license to users within each team. Citizen Developer
users with the CD (Marketing) role can create and run bots on their devices. When a user with the CD
(Marketing) role publishes a bot to a public folder, other Citizen Developer users within the Marketing team
can clone and run this bot on their devices.
Similarly, Citizen Developer users with the CD (Finance) role will have the same capabilities within the
Finance team folders. However, users from one team cannot access any folders and published bots from
the other team.
Attività correlate
Create a Citizen Developer user alla pagina 2689
A Citizen Developer is a business user who can build and run bots on their devices, which then function as
their digital assistants.
Create a Citizen Developer role alla pagina 2707
A Citizen Developer role enables the associated users to create and run bots on their registered devices.
Adding event triggers alla pagina 2626
Any bot with triggers can be associated with users or role to enable event trigger. Control Room user (or
role) with Manage event triggers permission can add event triggers.
Riferimenti correlati
Licenze Automation 360 alla pagina 1010
La pagina Tutte le licenze mostra informazioni dettagliate sulle licenze correnti di prodotti e dispositivi.

Create a Citizen Developer user
A Citizen Developer is a business user who can build and run bots on their devices, which then function as
their digital assistants.
Ensure that you are logged in to the  as the administrator.
1. Accedi ad Amministrazione > Utenti.
2. Fai clic su Crea utente.
3. Enter the following user details:
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a) Select the Enable User option if you want the user to be able to log in immediately.
b) Inserisci un nome utente univoco.
c) Opzionale: Inserisci una descrizione per l'utente.
d) Opzionale: Enter the first name and last name.

Nota:  The number of characters allowed for the first and last name is 50.

e) Enter and confirm a password for the user.
Ensure the password follows any necessary password policy.

f) Inserisci e conferma l'indirizzo e-mail dell'utente.
Se il protocollo SMTP è abilitato, all'utente viene inviata un'e-mail a questo indirizzo per
confermare l'account. All Control Room notifications will be sent to this email address.

4. Select a Citizen Developer role from the list of Available roles.
If there is no Citizen Developer role available, create one in Control Room.
Create a Citizen Developer role alla pagina 2707

5. Click the right arrow (→) to add your selection.
6. Assign the Citizen Developer license to the user.

The license enables users access to the Control Room only and enables them to create and run bots.
L'opzione Ignora il disclaimer di limitazione della responsabilità viene abilitata
automaticamente per consentire all'utente di eseguire bots su un dispositivo senza dover accettare
manualmente una dichiarazione di non responsabilità.

7. Fai clic su Crea utente.

Utente multi-login
Un utente multi-login può accedere a più sessioni di una Control Room attraverso l'API allo stesso tempo.
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Nota:  Non sono consentite sessioni multiple per l'accesso alla Control Room attraverso l'interfaccia utente.

È necessario un token multi-login se si vuole configurare un utente Control Room affinché utilizzi diversi
processi allo stesso tempo utilizzando token multipli generati utilizzando l'API. Hai bisogno di un ruolo di
amministratore Control Room per impostare un utente come utente del servizio multi-login. Puoi impostare
un utente come utente multi-login sia nell'interfaccia utente che nell'API.
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Autorizza usando l'interfaccia utente Autorizzare usando l'API

Nella Control Room, vai a Amministrazione >
Utenti e seleziona Consenti sotto Consenti
sessioni multiple per abilitare il multi-login.

Using the Authentication API
Richiesta

POST http://{{ControlRoomURL}}/v1/
authentication

Corpo della richiesta per generare il token
multi-login:

{
   "username":"jdoe",
   "password":"mypassword@123",
   "multipleLogin":true
}

Reset user password
The Control Room administrator generates an email process for the user to reset their password.
Ensure that you are logged in to the  as the administrator.
The change password email process.
1. Accedi ad Amministrazione > Utenti.
2. Select user from the list.
3. Click the Edit icon. ( )
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4. Select Send reset password email.

Nota:  If there is no email server configured, follow these steps to reset the password for a user:
a. Open the URL for the Control Room in your browser.
b. Enter the user name, click Forgot Password, and follow the prompts to reset or change the

password.
c. Enter the user name, click the Forgot Password button, and follow the prompts to reset or change

the password.

The selected user receives an email with the necessary instructions to reset the password.

Attività correlate
Accesso alla Automation Anywhere Control Room alla pagina 1022
Per accedere a Automation 360, apri l'URL Control Room nel browser, immetti le credenziali nella
schermata di accesso e fai clic su Accedi.

Ruoli
The Control Room enforces role-based access control. There are two types of roles: system and user-
created.
Role-based access control (RBAC) gives users access to specific features, based on the assigned roles and
the accessibility provided to the user. The benefits of creating roles include:
• Increased security through controlling users access according to their specified roles.
• Decreased need of customer support.
• Easy and accurate monitoring of the use and access of data by higher management, leading to better

research management.

System roles These roles are preconfigured with the permissions
necessary to perform the tasks within the scope of
that role. They cannot be modified or deleted.
System roles alla pagina 2709

User-created roles Users create these roles and the roles can be
customized. If a user-created role is created with
all Control Room permissions, it is not considered a
Control Room Admin role. Only the system-created
AAE_Admin role has this privilege.
Create a role alla pagina 2693

Before removing a user role from the active RPA, administrators should make certain all unfinished
development of bots are checked-in.

Create a role
As an administrator, you can configure roles with permissions to access features and perform operations
such as create, edit, or delete a bot in the Control Room, and assign the role to a user.
Ensure that you are logged in to the  as the administrator.
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Assign specific permissions to each user. You cannot select users, if these users are deactivated by the
Control Room administrator.
1. Vai a Amministrazione > Ruoli.
2. Click Create role.
3. Inserisci il Nome.
4. Opzionale: Immetti una descrizione.
5. Select the feature permissions.

For more information about the available feature permissions by product, see Autorizzazioni per le
funzioni di un ruolo alla pagina 2694.

6. Fai clic su Avanti.
7. Based on the option you select, perform the required action:

Opzione Azione

View my bots permission Select the bots permissions.
Bot permissions for a role alla pagina 2706

Run my bots permission Select the Bot Runner devices.

Visualizza le attività di tutti gli utenti dalle
mie cartelle

Consente all'utente di visualizzare l'attività dei
bot avviata da altri utenti dalle cartelle in cui
dispone dell'autorizzazione per l'esecuzione o la
programmazione.

Gestisci le attività di tutti gli utenti dalle
mie cartelle

Consente di gestire le attività dei bot, ad esempio
Metti in pausa, Riprendi e Sospendi,
avviate da diversi utenti dalle cartelle in cui
disponi dell'autorizzazione per l'esecuzione o la
programmazione.

8. Fai clic su Avanti.
9. Select user from the list.
10. Click Create role.

Concetti correlati
Bot permissions for a role alla pagina 2706
Assign bot permissions when creating a role with the View my bots feature permission.
Riferimenti correlati
System roles alla pagina 2709
System roles are preconfigured with the permissions necessary to perform the tasks within the scope of
that role. They cannot be modified or deleted. Administrators assign the roles to users to enable them to
access features and perform operations in the Control Room.

Autorizzazioni per le funzioni di un ruolo
Un utente con il ruolo AAE_Admin o un ruolo personalizzato con l'autorizzazione Gestisci ruoli può
creare e assegnare ruoli agli utenti, per fornire loro l'accesso a funzionalità e operazioni.
Ti consigliamo di creare singoli ruoli con autorizzazioni specifiche. Puoi assegnare ruoli limitati agli utenti
con solo quel requisito di autorizzazione specifico.
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Automation Anywhere Robotic Interface (AARI)

Autorizzazione Descrizione

Lettura trasversale team Visualizza tutti i team e i membri del team

Lettura-trasversale
processi

Visualizza tutti i processi, i membri del team e i gestori

Gestione team Crea e visualizza team, modifica nomi, descrizioni e tag di processo.
Aggiungi nuovi team, membri del team e processi assegnati

Gestione attività Invia e visualizza le attività dai processi assegnati al team

Gestione casi Crea e visualizza le richieste dai processi assegnati al team

Gestione globale casi Visualizza le richieste e le attività di processo.

Nota:  Questa autorizzazione non consente di creare una richiesta o
inviare un'attività

Gestione globale processi Visualizza i processi pubblici archiviati, i gestori e i team assegnati,
modifica i tag di processo e assegna gestori e team

Nota:  Questa autorizzazione non consente di creare un processo.

Gestione globale team Visualizza i team e gli utenti assegnati, modifica i nomi e le descrizioni
dei team. Aggiungi nuovi processi, gestori e utenti a un team

Nota:  Questa autorizzazione non consente di creare un team.

API

Autorizzazione Descrizione

Bot Insight Data API Consente all'utente di accedere alle API REST
di Bot Insight per accedere ai dati registrati da
Control Room e da un'attività durante le sessioni di
produzione.

Genera chiave API Gli utenti possono generare una apiKey che può
essere utilizzata nell'API di autenticazione.

Nota:  Gli utenti che non dispongono
dell'autorizzazione generateapikey possono
utilizzare le API, effettuando l'autenticazione
utilizzando il nome utente e la password.
Authentication API
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Attività

Autorizzazione Descrizione

Visualizza la mia Attività in corso Consente agli utenti di visualizzare la propria
attività.

Nota:  Per impostazione predefinita, tutti i ruoli
dispongono di questa autorizzazione.

Gestisci la mia Attività in corso Consente agli utenti di mettere in pausa,
riavviare o annullare la propria attività e
trasferire le attività completate nella cronologia.

Visualizza l’Attività in corso di tutti Consente agli utenti di monitorare le automazioni
in corso per le quali l'utente dispone di accesso
per l'esecuzione o la programmazione nel
rispettivo bot.

Gestisci l'Attività in corso di tutti Consente agli utenti di mettere in pausa,
riavviare o annullare la propria attività e
trasferire le attività completate nella cronologia.

Visualizza i miei bots programmati Allows users to view their own schedules only.

Programma i miei bots per l'esecuzione Consente agli utenti di programmare l'esecuzione
dei bots da eseguire. Inoltre, gli utenti devono
avere l'autorizzazione a visualizzare e a gestire
Bot Runners.

Modifica la mia attività pianificata Allows users to edit their own schedules only.

Elimina la mia attività pianificata Allows users to delete their own schedules only.

Visualizza e gestisci TUTTA l'attività pianificata
nelle mie Cartelle

Allows users to view, edit, and delete all the
schedules on the bot folders to which they have
access. It includes their own schedules and
schedules created by other users too.

Visualizza e gestisci TUTTA l’attività pianificata Consente agli utenti di visualizzare, modificare
ed eliminare tutti i programmi nel sistema.
Ciò include i programmi creati dall'utente e i
programmi creati da altri utenti.

Imposta la priorità automazione su alta Consente agli utenti di impostare la priorità
di automazione su alta per l'esecuzione e la
programmazione dei bots. Le automazioni con
priorità alta vengono privilegiate rispetto a quelle
con priorità media e bassa, in modo da poter
eseguire e programmare le automazioni ad alta
priorità.
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Log di audit

Autorizzazione Descrizione

Visualizza le azioni del log di audit di
tutti

Allows users to view all audit log activity for the Control
Room.

Bots

Autorizzazione Descrizione

Visualizza i miei bots Consente agli utenti di visualizzare i bots creati e
i bots che sono stati assegnati a loro.

Nota:  Devi assegnare questa autorizzazione
prima di assegnare qualsiasi altra autorizzazione
bots.

Esegui i miei bots Consente agli utenti di eseguire i bots creati e
bots che sono stati assegnati a loro.

Esporta bots Consente agli utenti di esportare bots e
dipendenze bot correlate per le quali dispongono
dell'autorizzazione allo scarico.

Importa bots Consente agli utenti di importare bots
e dipendenze bot per le quali hanno
l'autorizzazione al caricamento.

Etichetta bots Consente agli utenti di creare etichette per
una particolare versione di un bot. Queste
etichette consentono agli utenti di programmare,
eseguire, mettere in coda, esportare e attivare
flussi di lavoro di sviluppo di bot con la versione
desiderata.

Nota:  The Set production version permission
is redundant in Automation 360 although it
might be displayed when you migrate bots from
Enterprise 11. The Label bots permission is
the equivalent of Set production version in
Automation 360.
If you want to select the Export bots option,
you must select the Set production version
permission in such cases. Also, if you want to
provide the ability to set production version, you
must select the Label bots permission.

Crea cartelle Consente agli utenti di creare sottocartelle nelle
cartelle a cui hanno accesso.
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Autorizzazione Descrizione

Rinomina cartelle Consente agli utenti di rinominare le cartelle a
cui hanno accesso.

Nota:  Solo le cartelle vuote possono essere
rinominate.

Cancella checkout Consente agli utenti di annullare il checkout di
bot e sbloccare il file dall'archivio pubblico.

Bot Store

Autorizzazione Descrizione

Visualizza Bot Store Consente agli utenti di visualizzare il Bot Store.

Aggiunge bots da Bot Store a I miei Bots Consente agli utenti di aggiungere packages bot
da Bot Store al proprio spazio di lavoro privato
Control Room.

Invia bot a Bot Store Consente agli utenti di inviare packages bot a
Bot Store.

Credenziali e lockers

Autorizzazione Descrizione

Gestisci i miei lockers Consente agli utenti di creare e gestire i propri
lockers.

Crea attributi standard per credenziali Allows users to create a standard attribute for a
credential that is shared across all users of that
credential.

Visualizza e modifica il valore degli attributi di
TUTTE le credenziali

Consente agli utenti di visualizzare e modificare i
propri attributi mascherati.

Nota:  Non puoi modificare gli attributi delle
credenziali di altri utenti.

Bot Auto-Login Credentials API Consente agli utenti di automatizzare il processo
di accesso per eseguire in remoto bots.

Nota:  Un utente con il ruolo AAE_Locker Admin può visualizzare tutte le credenziali e gli armadietti in
Control Room. Consulta System roles alla pagina 2709.
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Dashboard

Autorizzazione Descrizione

Visualizza dashboard Consente agli utenti di visualizzare il dashboard.

Nota:  Per impostazione predefinita, tutti i ruoli
dispongono di questa autorizzazione.

Dispositivi

Autorizzazione Descrizione

Registra il dispositivo Consente agli utenti di registrare un dispositivo
host locale. Dispositivi alla pagina 2628

Visualizza e gestisci TUTTI i dispositivi Consente agli utenti di visualizzare e gestire tutti
i dispositivi in Control Room.

Attesta credenziali dispositivo Consente agli utenti di attestare le credenziali
del dispositivo per gli utenti Bot Runner. Puoi
distribuire bots su dispositivi utente con sessione
utente attiva e sbloccata senza password
di sistema per aggirare la convalida delle
credenziali.

Nota:  Questo funziona solo se l'impostazione
di accesso automatico Riutilizza una sessione
esistente è selezionata nella Control Room
dall'amministratore.

Elimina dispositivi Consente agli utenti di modificare i dispositivi
che sono autorizzati a vedere.

Modifica dispositivi Consente agli utenti di modificare i dispositivi
che sono autorizzati a vedere.
Allows you to view and manage all (registered
and non-registered) devices from a specific
accessible group.

Nota:  To view and manage registered and non-
registered devices,
• The Control Room administrator must grant

access to manage a specific set of devices.
• You must select Devices from my device

pool(s) to edit devices from device pools and
Run as user(s) default device to edit Run
as user(s) default device options in the Edit
devices permission.
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Autorizzazione Descrizione

Visualizza e gestisce i miei Bot Creators, Bot
Runners e pool di dispositivi

Consente agli utenti di visualizzare e gestire Bot
Creators, Bot Runners e pool di dispositivi.

Nota:  Per impostazione predefinita, tutti i ruoli
dispongono di questa autorizzazione.

Crea pool di dispositivi Consente agli utenti di creare e gestire i propri
pool di dispositivi.

Nota:  Un utente con il ruolo di AAE_Pool Admin può gestire tutti i pool di dispositivi in Control Room.
Consulta System roles alla pagina 2709.

Discovery Bot processo

Autorizzazione Descrizione

Visualizza il processo assegnato Consente agli utenti di visualizzare i processi
assegnati.

Nota:  Questa è l'autorizzazione standard.
Devi assegnare questa autorizzazione prima di
assegnare qualsiasi altra autorizzazione process
discovery.

Visualizza tutti i processi Consente agli utenti di visualizzare tutti i processi
definiti.

Modifica processo Consente agli utenti di creare e modificare i
processi.

Registrazione Discovery Bot

Autorizzazione Descrizione

Visualizza tutte le registrazioni Consente agli utenti di visualizzare tutte le registrazioni.

Visualizza le tue registrazioni Consente agli utenti di visualizzare la propria registrazione.

Nota:  Devi assegnare questa autorizzazione prima di
assegnare una qualsiasi delle autorizzazioni seguenti.

Avvia il registratore e crea
registrazioni

Consente agli utenti di avviare il registratore e creare
registrazioni.

Modifica le tue registrazioni Consente agli utenti di modificare le proprie registrazioni.

Elimina le tue registrazioni Consente agli utenti di eliminare le proprie registrazioni.
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Aggregazione Discovery Bot

Autorizzazione Descrizione

Visualizza tutte le aggregazioni Consente agli utenti di visualizzare tutte le
aggregazioni.

Visualizza la propria aggregazione Consente agli utenti di visualizzare le proprie
aggregazioni.

Nota:  Devi assegnare questa autorizzazione prima di
assegnare una qualsiasi di quelle riportate di seguito.

Crea o elimina la propria aggregazione Consente agli utenti di creare ed eliminare
aggregazioni.

Modifica aggregazione Consente agli utenti di aggiornare le aggregazioni.

Visualizza aggregazione creata dal sistema Consente agli utenti di visualizzare le aggregazioni di
sistema.

Opportunità Discovery Bot

Autorizzazione Descrizione

Visualizza tutte le opportunità Consente agli utenti di visualizzare tutte le
opportunità.

Visualizza opportunità Consente agli utenti di visualizzare le opportunità
esistenti nel processo assegnato.

Nota:  Devi assegnare questa autorizzazione
prima di assegnare una qualsiasi di quelle
riportate di seguito.

Crea o elimina opportunità Consente agli utenti di creare ed eliminare le
opportunità esistenti nel processo assegnato.

Converti in bot Consente agli utenti di convertire un'opportunità
in un bot.

Esporta opportunità Consente agli utenti di esportare un'opportunità.

Trigger di evento

Autorizzazione Descrizione

Visualizza trigger di evento Consente agli utenti di visualizzare i trigger di
evento.
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Autorizzazione Descrizione

Gestisci trigger di evento Consente agli utenti di visualizzare e gestire i
trigger di evento.

Nota:  Devi assegnare l'autorizzazione view
prima di assegnare questa autorizzazione.

IQ Bot

Autorizzazione Descrizione

Visualizza IQ Bot Consente agli utenti di visualizzare i dashboard
predefiniti nel portale IQ Bot.

Nota:  Devi assegnare questa autorizzazione prima di
assegnare qualsiasi altra autorizzazione IQ Bot.

Autorizzazioni per l'amministrazione IQ Bot

ID Autorizzazione Descrizione

Visualizza amministrazione Consente agli utenti di accedere alla scheda Amministrazione
nel portale IQ Bot.

Nota:  Devi assegnare questa autorizzazione prima di assegnare
qualsiasi altra autorizzazione di amministrazione.

Visualizza e gestisci impostazioni Consente agli utenti di gestire impostazioni di configurazione
avanzate del portale IQ Bot.

Visualizza e gestisci migrazione Consente agli utenti di accedere all'utilità di migrazione per
esportare e importare istanze di apprendimento nel portale IQ
Bot.

Autorizzazioni ai domini IQ Bot

Autorizzazione Descrizione

Visualizza domini Consente agli utenti di visualizzare tutti i domini nel portale IQ Bot.

Nota:  Devi assegnare questa autorizzazione prima di assegnare qualsiasi
altra autorizzazione al dominio.

Crea domini Consente agli utenti di creare domini nel portale IQ Bot.

Importa domini Consente agli utenti di importare domini nel portale IQ Bot.
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Autorizzazione Descrizione

Esporta domini Consente agli utenti di esportare domini nel portale IQ Bot.

Autorizzazioni alle istanze di apprendimento IQ Bot

Autorizzazione Descrizione

Visualizza istanze di apprendimento Consente agli utenti di visualizzare le rispettive
istanze di apprendimento nel portale IQ Bot.

Nota:  Devi assegnare questa autorizzazione
prima di assegnare qualsiasi altra autorizzazione
per le istanze di apprendimento.

Visualizza istanze di apprendimento dello stesso
ruolo

Consente agli utenti di visualizzare istanze di
apprendimento create da altri utenti con lo
stesso ruolo nel portale IQ Bot.

Visualizza TUTTE le istanze di apprendimento Consente agli utenti di visualizzare tutte le
istanze di apprendimento nel portale IQ Bot.

Lancia validatore Consente agli utenti di accedere al Validator IQ
Bot per esaminare e aggiornare i documenti con
eccezioni.

Crea istanze di apprendimento Consente agli utenti di creare istanze di
apprendimento nel portale IQ Bot.

Modifica istanze di apprendimento Consente agli utenti di modificare istanze di
apprendimento nel portale IQ Bot.

Elimina istanze di apprendimento Consente agli utenti di eliminare le rispettive
istanze di apprendimento nel portale IQ Bot.

Invia istanze di apprendimento in produzione Consente agli utenti di inviare le rispettive
istanze di apprendimento in produzione nel
portale IQ Bot.

Allena gruppi di istanze di apprendimento Consente agli utenti di eseguire la formazione
dei rispettivi gruppi di istanze di apprendimento
nel portale IQ Bot.

Gestore Package

Autorizzazione Descrizione

Visualizza packages Consente agli utenti di visualizzare il packages.

Gestisci packages Consente agli utenti di visualizzare e gestire
packages.
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Licenze

Autorizzazione Descrizione

Visualizza licenze Consente agli utenti di visualizzare i dettagli della
licenza per Control Room.

Gestisci licenze del dispositivo dell’utente Consente agli utenti di assegnare licenze di
dispositivo ad altri utenti.

Installa licenze Consente agli utenti di installare licenze
Automation 360 per Control Room.

Criteri

Autorizzazione Descrizione

Visualizza i criteri Consente agli utenti di visualizzare i criteri che definiscono le modalità di
creazione delle automazioni.

Gestisci criteri Consente agli utenti di visualizzare e gestire i criteri che definiscono le
modalità di creazione delle automazioni.

Migrazione

Autorizzazione Descrizione

Visualizza migrazione Allows users to view new migrations, but not run
them.

Nota:  You must assign this permission before
assigning the manage migration permission.

Gestisci migrazione Allows users to view and run new migrations.

Consenti a un utente Bot Runner di eseguire
migrazioni

Allows Bot Runner user to update the bot
conversion status in the Control Room.

Impostazioni

Nota:  Solo un utente con il ruolo AAE_Admin ha la possibilità di visualizzare e gestire le impostazioni in
Control Room. Consulta System roles alla pagina 2709.
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Utenti e ruoli

Autorizzazione Descrizione

Visualizza utenti Consente agli utenti di visualizzare soltanto tutti gli altri
utenti nel sistema. Non possono creare, modificare né
eliminare utenti.

Nota:  Devi assegnare questa autorizzazione prima di
assegnare le autorizzazioni Create user, Update user
o Delete user.

Elimina utenti Consente agli utenti di eliminare altri utenti in Control
Room.

Crea utenti Consente agli utenti di creare nuovi utenti in Control
Room.

Modifica utenti Consente agli utenti di modificare tutti gli utenti nel
sistema.

Visualizza ruoli Gli utenti con questa autorizzazione sono in grado di
visualizzare i ruoli in Control Room.

Nota:  Devi assegnare questa autorizzazione prima di
assegnare l'autorizzazione Manage roles.

Gestisci ruoli Consente agli utenti di visualizzare e gestire tutti i ruoli in
Control Room.

Visualizza le informazioni di base degli
utenti e dei ruoli

Consente agli utenti di visualizzare le informazioni di base
su utenti e ruoli in Control Room.

Workload Management (WLM)

Autorizzazione Descrizione

Visualizza e gestisci le mie code Allows users to view and manage their own queues.

Pianifica i miei bot per l’esecuzione Allows a user to run a bot with queue

View and manage all activities from
my folders

Allows users to pause, resume, and stop all the WLM
automations on the bot folders which they have access to.

View and manage all activities Allows users to pause, resume, and stop all the WLM
automations.

Crea code Consente agli utenti di creare e gestire le proprie code.

Calcolatore SLA… Consente agli utenti di calcolare i Service Level Agreement
(SLA) del carico di lavoro.

Nota:  This permission is not in use.
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Nota:  Un utente con il ruolo di AAE_Queue Admin ha tutte le autorizzazioni per il carico di lavoro.
Inoltre, AAE_Queue Admin può gestire tutte le code in Control Room. Consulta System roles alla pagina
2709.

Autorizzazioni per Update Bot wizard

Puoi assegnare le autorizzazioni per le funzioni per accedere e convertire un bot da Internet Explorer a
Microsoft Edge con IE utilizzando Update Bot wizard. Queste autorizzazioni possono essere assegnate
dalla pagina Amministrazione > Ruoli > Crea o modifica ruoli.

Autorizzazione Descrizione

Visualizza aggiornamento bot Consente all'utente di visualizzare lo
stato e il riepilogo di ciascuna istanza di
aggiornamento bot quando i bots vengono
convertiti nella pagina Update Bot wizard
> Amministrazione. Tuttavia, l'utente
non può eseguire aggiornamenti. Per farlo,
l'utente ha bisogno dell'autorizzazione Gestisci
aggiornamento bot.

Gestisci aggiornamento bot Consente all'utente di eseguire nuovi
aggiornamenti bot utilizzando Update Bot wizard.

Consenti a un utente Bot Runner di aggiornare
bots

Consente agli utenti Bot Runner di inviare lo
stato di aggiornamento del bot a Control Room
in modo che sia visibile nel rapporto Update Bot
wizard.
Per impostazione predefinita, questa
autorizzazione è assegnata all'utente con ruolo
AAE_Admin.

Bot permissions for a role
Assign bot permissions when creating a role with the View my bots feature permission.

Autorizzazione Descrizione

Seleziona tutto Enables users to check in, check out, view, delete, run, and schedule bots.

Run/Schedule/Run
and Schedule

Enables users to run and schedule bots when the role has the Run my bots and
Schedule my bots to run feature permissions.

Nota:
• This permission is limited to running bots when the role has only the Run my

bots feature permission.
• This permission is limited to scheduling bots when the user has only the

Schedule my bots to run feature permission.

Archivia … Enables users to check in bot files or folders to the public workspace from their
private workspace. When this permission is selected, the Clone and View content
permissions are automatically enabled. These permissions can only be disabled by
an user with the AAE_Admin role .
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Autorizzazione Descrizione

Estrai Enables users to check out bot files or folders from the public workspace. It creates
an editable copy of the bot in the private workspace. A bot can be checked out by
one user at a time. When this permission is selected, the Clone and View content
permissions are automatically enabled. These permissions cannot be disabled.

Nota:  To check out dependent folders and files, you must have the Check out
permission on the dependency folders.

Visualizza il
contenuto

Enables users to view the contents of a bot. This permission applies to both the
public and private workspaces. To create a copy of the cloned bot or file in the
private workspace, you must have the View content permission on the same
folder in the public workspace.

Nota:  You must have the View content permission enabled to export a bot and
its dependencies.

Clona Enables users to create a read-only copy of the bot from the public workspace
to their private workspace. A bot can be cloned by multiple users. The Clone
permission must be assigned at the folder level for the bot in the public workspace.
To clone a dependency folder, you must have the Clone permission on the
dependency folder.

Nota:
• If you have cloned a bot and the corresponding public folder is deleted, then

there will be no classifications on the cloned bot in your private workspace.
Copy, view, or delete permissions will be available at the bot level.

• You cannot move or rename a cloned bot in your private workspace. You must
have the View content permission on the same folder in the public workspace
to view the contents of your cloned bot in the private workspace.

Elimina Enables users to remove files and their dependencies from the public workspace.

Attività correlate
Create a role alla pagina 2693
As an administrator, you can configure roles with permissions to access features and perform operations
such as create, edit, or delete a bot in the Control Room, and assign the role to a user.

Create a Citizen Developer role
A Citizen Developer role enables the associated users to create and run bots on their registered devices.
Ensure that you are logged in to the  as the administrator.
Although you can create a Citizen Developer role and assign additional custom bot permissions, ensure the
role has all the feature permissions mentioned in this procedure.
1. Vai a Amministrazione > Ruoli.
2. Click Create role.
3. Inserisci il Nome.
4. Opzionale: Immetti una descrizione.
5. Select the following feature permissions:

• Trigger di evento
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Select the View and manage my event triggers option to allow the user to view, run trigger-
based automation, or delete event triggers.

Nota:  The View and Manage my event triggers option is specific to the Citizen Developer
license and can fail if it is assigned to users with Bot Creator or other licenses. Adding trigger
events from the private repository is not supported.

• Bots
Select the View my bots option and the following permissions:
• Run my bots
• Import bots
• Cancel checkout

• Dispositivi
Select the following permissions:
• Register device
• View and manage ALL device(s)
• Edit the device(s)

6. Fai clic su Avanti.
7. Click Create role.

A Citizen Developer role is created in the Control Room. You can create a Citizen Developer user and
assign this role to that user.
Create a Citizen Developer user alla pagina 2689

Assign a role
Roles grant specific permissions to users, such as Bot Creators and Bot Runners.
Ensure that you are logged in to the  as the administrator.
Assign specific permissions to each user. You cannot select users, if these users are deactivated by the
Control Room administrator.
1. Vai a Amministrazione > Ruoli.
2. Click Create role.
3. Inserisci il Nome.
4. Opzionale: Immetti una descrizione.
5. Set the required permissions for the role associated with this repository.
6. Fai clic su Bot.
7. Select the desired repository folder and grant associating permissions.

Opzione Azione

Seleziona tutto Grant all associated permissions for the
repository.

Esegui Permission to run bots from the repository.

Archivia … Permission to import bots to the repository.

Estrai Permission to export the bot from of the
repository.
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Opzione Azione

Elimina da pubblico Permission to permanently remove bots from the
Public repository.

8. Opzionale: Click RUN AS.
This is where administrators select the specific device this role will have access to.

9. Click Create role.

Assign this role to the appropriate Bot Creator users.

System roles
System roles are preconfigured with the permissions necessary to perform the tasks within the scope of
that role. They cannot be modified or deleted. Administrators assign the roles to users to enable them to
access features and perform operations in the Control Room.
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Automation 360 ruoli

Ruolo Autorizzazioni

AAE_Admin
This role allows access to all features,
enables users to create other Admin
users, and access to all folders and
files in the public workspace, including
permissions to Create/Edit/Delete
Global Values. This is the only role that
can access Control Room settings.

Dashboard Visualizza dashboard
Attività • View and manage my in-

progress activity
• View and manage

everyone's in-progress
activity

• Visualizza i miei bots
programmati

• Programma i miei bots
per l'esecuzione

• Modifica la mia attività
pianificata

• Elimina la mia attività
pianificata

• Visualizza e gestisci tutta
l'attività programmata
dalle mie cartelle

• View and manage all
scheduled activity

Event Triggers View and manage event
triggers

Bots • View and run my bots
• Import and export my

bots
• Crea e rinomina le

cartelle
• Manage my credentials

and lockers
• Crea attributi standard

per credenziali
• Bot Auto-Login

credential API

Package Manager View and manage packages
Dispositivi • Registra il dispositivo

• View and manage all
devices

• View and manage
my Bot Runners, Bot
Creators, and device
pools

Carico di lavoro • Visualizza e gestisci le
mie code

• Gestisci tutte le code
• Calcolatore SLA

Bot Store • Visualizza Bot Store
• Submit bots to Bot Store

Audit Log View all audit log actions
Amministrazione • View and manage users

• View and manage roles
• Visualizza e gestisci

impostazioni
• Visualizza e gestisci

migrazione
• View, manage, and

install licenses

API Bot Insight Data API

AAE_Basic
This role provides permissions to
upload and download TaskBots in the
My Tasks folder. Limited access to
other features.

Dashboard Visualizza dashboard
Attività View my in-progress activity
Bots • View and run my bots

• Manage my credentials
and lockers

• Crea attributi standard
per credenziali

Package Manager Visualizza packages
Dispositivi • Registra il dispositivo

• View and manage
my Bot Runners, Bot
Creators, and device
pools

Carico di lavoro Visualizza e gestisci le mie
code

Bot Store Visualizza Bot Store
Amministrazione View basic information

about users and roles

AAE_Bot Developer
This role allows users to download
bots or packages from Bot Store to the
Control Room private workspace.

Nota:  This role does not grant
permission to register a device, or
check bots in or out of the public
workspace.

Dashboard Visualizza dashboard
Attività View my in-progress activity
Bots • View and run my bots

• Importa bots
• Crea cartelle
• Manage my credentials

and lockers
• Crea attributi standard

per credenziali

Package Manager View and manage packages
Dispositivi View and manage my Bot

Runners, Bot Creators, and
device pools

Carico di lavoro Visualizza e gestisci le mie
code

Bot Store View and download bots
from Bot Store

Amministrazione View basic information
about users and roles

AAE_Locker Admin
Can view all credentials and all
lockers. Questo ruolo permette anche
di modificare il proprietario di una
credenziale che non si possiede. For
lockers they do not own, they can
delete the locker, edit permissions, and
remove credentials.

Dashboard Visualizza dashboard
Attività View my in-progress activity
Bots • Manage my credentials

and lockers
• Administer all lockers
• Crea attributi standard

per credenziali

Dispositivi View and manage my Bot
Runners, Bot Creators, and
device pools

Carico di lavoro Visualizza e gestisci le mie
code

Amministrazione View basic information
about users and roles

AAE_Pool Admin
Autorizzazioni per visualizzare e gestire
tutti i pool di dispositivi.

Nota:  Questo ruolo non concede
l'autorizzazione per visualizzare bots.

Dashboard Visualizza dashboard
Attività View my in-progress activity
Bots • Manage my credentials

and lockers
• Crea attributi standard

per credenziali

Dispositivi • View and manage
my Bot Runners, Bot
Creators, and device
pools

• Crea pool di dispositivi
• Amministra tutti i pool di

dispositivi

Carico di lavoro Visualizza e gestisci le mie
code

Amministrazione View basic information
about users and roles

AAE_Queue Admin
Autorizzazioni per visualizzare e gestire
tutte le code.

Dashboard Visualizza dashboard
Attività View my in-progress activity
Bots • Manage my credentials

and lockers
• Crea attributi standard

per credenziali

Dispositivi View and manage my Bot
Runners, Bot Creators, and
device pools

Carico di lavoro • Visualizza e gestisci le
mie code

• Crea code
• Gestisci tutte le code
• Calcolatore SLA

Amministrazione View basic information
about users and roles

AAE_Bot Migration Admin
This role allows users to view and
manage the bot migration process.

Nota:  This role also has permissions
to view content, and check in and
check out bots from the Bots, My
 Tasks, and My MetaBots folders.
These folder permissions are implicit
and not displayed on the application.

Dashboard Visualizza dashboard
Attività View my in-progress activity
Bots • Visualizza i miei bots

• Manage my credentials
and lockers

• Crea attributi standard
per credenziali

• View and edit all
credential attributes
values

Package Manager Visualizza packages
Dispositivi • Registra il dispositivo

• View and manage
my Bot Runners, Bot
Creators, and device
pools

Carico di lavoro Visualizza e gestisci le mie
code

Audit Log Visualizza le azioni del log di
audit di tutti

Amministrazione • View basic information
about users and roles

• Visualizza migrazione
• Gestisci migrazione
• Allow a Bot Runner to

perform migrations
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IQ Bot ruoli

Ruolo Autorizzazioni

AAE_IQ Bot Validator
Per un Bot Runner con una licenza di IQ Bot.
Autorizzazioni per accedere alla schermata
di IQ Bot Validator. L'accesso alle funzionalità
della Control Room è limitato.

Dashboard Visualizza dashboard
Attività View my in-progress

activity
Bots • Manage my

credentials and
lockers

• Crea attributi
standard per
credenziali

Dispositivi View and manage
my Bot Runners, Bot
Creators, and device
pools

Carico di lavoro Visualizza e gestisci le
mie code

Audit Log View all audit log actions
Amministrazione View basic information

about users and roles
IQ Bot • Visualizza IQ Bot

• Visualizza istanze di
apprendimento

• Lancia validatore

AAE_IQ Bot Services
Autorizzazioni per accedere alla console IQ
Bot. L'accesso alle funzionalità della Control
Room è limitato.

Dashboard Visualizza dashboard
Attività View my in-progress

activity
Bots • Manage my

credentials and
lockers

• Crea attributi
standard per
credenziali

Dispositivi View and manage
my Bot Runners, Bot
Creators, and device
pools

Carico di lavoro Visualizza e gestisci le
mie code

Audit Log View all audit log actions
Amministrazione View basic information

about users and roles
IQ Bot • Visualizza IQ Bot

• Visualizza istanze di
apprendimento

• Visualizza istanze di
apprendimento dello
stesso ruolo

• Visualizza tutte
le istanze di
apprendimento

• Lancia validatore
• Crea istanze di

apprendimento
• Modifica istanze di

apprendimento
• Elimina istanze di

apprendimento
• Invia istanze di

apprendimento in
produzione

• Allena gruppi
di istanze di
apprendimento

AAE_IQ Bot Admin
Consente di accedere a tutte le funzionalità
del IQ Bot.

Dashboard Visualizza dashboard
Attività View my in-progress

activity
Bots • Manage my

credentials and
lockers

• Crea attributi
standard per
credenziali

Dispositivi View and manage
my Bot Runners, Bot
Creators, and device
pools

Carico di lavoro Visualizza e gestisci le
mie code

Audit Log View all audit log
actions.

Amministrazione View basic information
about users and roles

IQ Bot • Visualizza IQ Bot
• Visualizza istanze di

apprendimento
• Visualizza istanze di

apprendimento dello
stesso ruolo

• Visualizza tutte
le istanze di
apprendimento

• Lancia validatore
• Crea istanze di

apprendimento
• Modifica istanze di

apprendimento
• Elimina istanze di

apprendimento
• Invia istanze di

apprendimento in
produzione

• Allena gruppi
di istanze di
apprendimento

• Visualizza domini
• Crea domini
• Importa domini
• Esporta domini
• Visualizza

amministrazione
• Visualizza e gestisci

impostazioni
• Visualizza e gestisci

migrazione
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Bot Insight ruoli

Consulta Ruoli per accedere a Bot Insight alla pagina 2954.
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Discovery Bot ruoli

Ruolo Autorizzazioni

AAE_Discovery Bot Admin
Consente l'accesso per visualizzare tutti i
processi Discovery Bot. Consente di gestire
la creazione, l'eliminazione e la modifica dei
processi.

Dashboard Visualizza dashboard
Attività View my in-progress

activity
Bots Manage my credentials

and lockers
Dispositivi View and manage

my Bot Runners, Bot
Creators, and device
pools

Carico di lavoro Visualizza e gestisci le
mie code

Amministrazione View information about
users and roles

Discovery Bot • Visualizza tutti i
processi

• Modifica processo

AAE_Discovery Bot Analyst
Consente di accedere alla visualizzazione di
tutte le registrazioni approvate dagli utenti
assegnati per un determinato processo.
Permissions for system-generated aggregated
view of recordings to view, create, edit,
and delete views. Autorizzazioni per creare,
visualizzare, modificare ed eliminare
opportunità per i processi assegnati. Export
the opportunity to a word document and
convert to a bot.

Dashboard Visualizza dashboard
Attività View my in-progress

activity
Bots Manage my credentials

and lockers
Dispositivi View and manage

my Bot Runners, Bot
Creators, and device
pools

Carico di lavoro Visualizza e gestisci le
mie code

Amministrazione View basic information
about users and roles

Discovery Bot • View assigned
processes

• Visualizza tutte le
registrazioni

• Visualizza tutte le
aggregazioni

• Visualizza la propria
aggregazione

• Crea o elimina la
propria aggregazione

• Modifica
aggregazione

• View system-
generated
aggregation

• Visualizza
opportunità

• Crea o elimina
opportunità

• Modifica opportunità
• Converti in bot

AAE_Discovery Bot User
Consente l'accesso per visualizzare il processo
Discovery Bot assegnato a un utente. Crea
ed esegue il registratore Discovery Bot per i
processi aziendali assegnati. Autorizzazioni
per visualizzare, modificare ed eliminare le
registrazioni di un utente.

Dashboard Visualizza dashboard
Attività View my in-progress

activity
Bots Manage my credentials

and lockers
Package Manager Visualizza pacchetti
Dispositivi • Registra il dispositivo

• View and manage
my Bot Runners, Bot
Creators, and device
pools

Carico di lavoro Visualizza e gestisci le
mie code

Amministrazione View basic information
about users and roles

Discovery Bot • Visualizza il processo
assegnato

• Visualizza le tue
registrazioni
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Automation Anywhere Robotic Interface ruoli

Ruolo Autorizzazioni

AAE_Robotic Interface Admin Dashboard Visualizza dashboard
Attività View my in-progress

activity
Bots Manage my credentials

and lockers
Dispositivi View and manage

my Bot Runners, Bot
Creators, and device
pools

Carico di lavoro Visualizza e gestisci le
mie code

Amministrazione • View and edit users
• View basic

information about
users and roles

AARI • Cross team read
• Cross process read
• Global case

management
• Global process

management
• Global team

management

AAE_Robotic Interface Manager Dashboard Visualizza dashboard
Attività View my in-progress

activity
Bots Manage my credentials

and lockers
Dispositivi View and manage

my Bot Runners, Bot
Creators, and device
pools

Carico di lavoro Visualizza e gestisci le
mie code

Amministrazione • View and edit users
• View basic

information about
users and roles

AARI • Team management
• Gestione casi
• Task management

AAE_Robotic Interface User Dashboard Visualizza dashboard
Attività View my in-progress

activity
Bots Manage my credentials

and lockers
Dispositivi View and manage

my Bot Runners, Bot
Creators, and device
pools

Carico di lavoro Visualizza e gestisci le
mie code

Amministrazione View basic information
about users and roles

AARI • Gestione casi
• Task management
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Export roles
You can export assigned users and Run as user roles to a CSV file to view folder permissions, and
included in offline audits and records.
Ensure that you are logged in to the  as the administrator.
You can export selected roles and their permissions to separate CSV files to view the following information:
• Role to user: Provides information about the users assigned to the role.
• Role to run-as user: Provides information about the run-as users assigned to the role.
• Role to permission: Provides information about the permissions assigned to the role.
• Role to folder permission: Provides information about the folder permissions assigned to the role.

You can download the CSV file with the exported roles from the Activity > Historical page.
1. Vai a Amministrazione > Ruoli.
2. Select the assigned users and Run as user roles that you want to export.
3. Click the Export checked items to CSV icon at the top-right corner of the table.

A message is displayed indicating that the exported CSV file is available from the Activity >
Historical page.

4. Click Continue.
5. Navigate to the Activity > Historical page and search for exported roles activity.

Nota:  You can search for role activity by username. The role activity name uses the following format:
Role-Export: Roles_admin_03122022155910111.

6. Click the role activity that you want to download.
7. Fai clic su Scarica file zip esportato.

The CSV file downloads to your local system as a zip file.

Manage Active Directory role mapping
An administrator or a user with permission to view and manage roles can view the details of the available
Active Directory role mappings.
Ensure that you are logged in to the  as the administrator.
By default, the Control Room will retrieve all security groups from the Users directory.
To create role mappings with filters for the Users directory along with other organizational units (OU), you
must update the um.properties file. In the Control Room, the Users directory is considered similar to
the OUs. Therefore, you must define the filter in the um.properties file.
For example, set the filter in the file as follows:

um.ldap.groupmapping.domain.filter='mydomain.com:OU1&groupFilter|
OU2&groupFilter|Users&groupFilter'

Nota:  Group filters such as groupFilter are optional.

In this example, by applying this change to the um.properties directs the Control Room to perform the
following tasks:
1. Go to domain mydomain.com
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2. Retrieve all security groups from Organization Unit OU1 that have the group name starts with
groupFilter.

3. Retrieve all security groups from Organization Unit OU2 that have the group name starts with
groupFilter.

4. Retrieve all security groups from Users directory that have the group name starts with groupFilter.

This setting ensures that the users from the organization units OU1 and OU2 will be retrieved in addition to
the Users directory.

Recommendation:  Use filters to narrow down the group display as displaying larger number of groups
impacts the performance and makes troubleshooting difficult.

The filters defined in the um.properties file are stored in the database. When you update to a newer
version of the Control Room, the Control Room references the filters stored in the database because the
default um.properties file that comes with the installation will not contain these filters. If you define
new filters in the default um.properties file, the Control Room references the filters defined in the
um.properties file and overwrites the ones stored in the database.
Multiple Domain Mapping
Mapping supports multiple domains separated by a coma.

um.ldap.groupmapping.domain.filter='mydomain.com:OU1&groupFilter|
OU2&groupFilter|Users&groupFilter,mydomain2.com:OU3|OU4'

In the example above, the Control Room will perform the additional processes:
1. Go to domain mydomain2.com
2. Retrieve all security groups from Organization Unit OU3.
3. Retrieve all security groups from Organization Unit OU4.

Retrieving security groups from nested OUs
Example for retrieving security groups from nested OUs.
In the following example organization, consider "Marketing" as the parent OU with additional nested OUs
and security groups located in each of these nested OUs.
• Marketing

• Gruppo 1
• Gruppo 2
• US_OU

• Gruppo 3
• California_OU

• Gruppo 4
• NoCal_OU

• Gruppo 5

• SoCal_OU
• Gruppo 6
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By adding the following entry, Control Room will retrieve all groups, group1, group2, group3, group4,
group5 and group6 from Marketing and the nested OUs.

um.ldap.groupmapping.domain.filter='mydomain.com:Marketing'

Nota:  Providing nested OU in the entry is not supported.

Active Directory role mapping
Navigate to Administration >  > Roles > Active Directory role mappings and the page displays any
role mappings that are created in the Control Room. You can view or edit the role mappings. You can also
create new role mappings or restart the role synchronization process between the Control Room and Active
Directory.
When enabled, this synchronization process is triggered once a day (1440 minutes) by default. You can
trigger synchronizations in any interval by changing the number of minutes. We recommend that you set
the interval settings larger than the default.

Recommendations:
• You should set the interval settings larger then the default setting of 1440 minutes.
• Do not use both Import and Do not import mappings in the same system because it may complicate

use cases and make troubleshooting more difficult to correct any issues.
• If both Import and Do not import mappings are defined and a user is included in both mappings,

then the Import mappings take precedence over the Do not import mappings.
Consider these examples:
• AD Mapping A = Role A – Group A – Import users from this group into Automation 360
• AD Mapping B = Role B – Group B – Do not import users from this group

Where user D is included in both Groups A and B within Active Directory.
User D will be created in Automation 360 and will be assigned Role A.
• AD Mapping A = Role A – Group A – Import users from this group into Automation 360
• AD Mapping B = Role B – Group B – Do not import users from this group
• AD Mapping C = Role C – Group C – Import users from this group into Automation 360

Where user D is included in Groups A, B, and C in Active Directory (AD).
User D will be created in Automation 360 and will be assigned to Role A and Role C.

One or more available role mappings that match your search criteria appear in the Role Mapping table.

Nota:  The role mappings page displays only the list of mappings and does not validate the mappings
by default. Because the changes in security groups and roles are infrequent and take more time in case
of slow network or higher number of mappings, the page displays only the list of mappings. To configure
default validation on the role mappings page, in the um.properties file, add the following entry:
um.ldap.groupmapping.sync.on.get.mappings=true. Validation of role mappings occurs when
you sync the role mappings between the Active Directory and the Control Room.

You can run automations either on the device which is set as your bot running device or from a device
pool for which you have consumer privileges (Create a user ). When using Active Directory role mapping, if
you want any mapped Active Directory user to be able to use more than one device, you must configure a
device pool (Create device pools).
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Sync Active Directory role mapping
Manually or automatically synchronize (sync) role mappings between the Active Directory and Control
Room.

Automatically synchronize Active Directory role mapping

By default, synchronizing between Active Directory and Control Room occurs by default at the time interval
of 1440 minutes (one day). The time interval for synchronization can be changed in the Active Directory
role mappings main page.

Nota:  As this can be a time-consuming and an expensive operation, set the role synchronization time
period to the default value of 1440 minutes (1 day).

Manually run or restart synchronizing Active Directory role mapping

To run or restart automatic synchronizing between the Active Directory and Control Room, do this: From
the Control Room go to the Active Directory role mappings page and click the Sync roles from
Active Directory option.
This starts the synchronizing process immediately and continues to run it automatically based on the time
interval set.

Cancel automatic synchronizing Active Directory role mapping

To cancel automatic synchronizing between Active Directory and Control Room, do this: From the Control
Room go to the Active Directory role mappings page and click the Cancel Sync option to turn off the
periodic automatic sync.

Events that require Active Directory role mapping sync

Sync the role mappings whenever these events occur:
• Changes to AD groups

If any group that is mapped is deleted from the AD, the mappings must be validated before they are
deleted because the group is no longer available.

• Update to the license file
Updating the license file can change the available roles. Mappings must be synchronized before
updating the roles.

Nota:  After a sync, the user must wait a few seconds for the updated changes to appear.

Create Active Directory role mapping
When users are created, they automatically inherit the roles assigned to their Active Directory security
groups. Create the mapping before synchronizing the user and roles during the user login or background
process.
To complete the task, you must have AAE_Admin role assigned to you. Ensure you are logged in to the
Control Room as the administrator.
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In order to create a role mapping, as the administrator will have to provide the following information:
• Unique mapping name.
• The targeted domain where the security groups will pulling the credentials from (see um.properties for

details).

Nota:
In order to avoid to import a long list of users, a specific security group should be created on the AD side
that has only the users who will access Control Room is recommended.

Map a single AD security group to one or more Control Room roles. Create any roles you want to use with
the Active Directory security groups. You can also use the default roles available in the Control Room. .

Nota:  It is recommended that the AAE_Admin role not be used.

1. Accedi a Control Room.
2. Vai a Amministrazione > Ruoli.
3. Click Active Directory Role Mapping.
4. Click Create Role Mapping.
5. Inserisci il Nome.
6. Click the Active Directory domain drop-down and select an available domain.
7. Use the Active Directory security group field to search for a group.

For example, if you have a group named Certified Publishers, search for Certified. All the
groups that contain Certified in their name are listed in GROUPS.

8. Choose whether Import users or Do not import users.
Opzione Outcome

Import users All the users who are assigned for the selected
security group will be created and assign the
mapped roles and licenses in Control Room. If
users already exist in Control Room, they will be
updated with the latest roles and licenses from
the mapping.
If synchronization process is enabled and
triggered, the existing Control Room users will
have the updated roles and licenses from the
mapping.
If there are new users added to the security
group on the Active Directory side, these users
will be created in the Control Room.
If there are users removed from the security
group, these users will be deleted from Control
Room.
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Opzione Outcome

Do not import users After the role mapping is created; no user will be
created in Control Room. How this mapping is
being used in this deployment:
• On the Create user configuration page,

when you create a new user, the role(s) will
automatically be assigned to the new user if
any of the user security group maps to the
existing role mapping.

• If synchronization process is enabled and
triggered, any existing Control Room users
whose security group maps to any role
mappings will get the role assignment
updated.

9. Click the right arrow (→) to add your selection.
10. Select the required role from the list of Available roles.
11. Click the right arrow (→) to add your selection.
12. Select the device licenses to assign to the security group.

License mapping is only supported when the Import users options is selected.

Nota:  The Do not import users option does not support license assignment. Administrators will
be required to map the licenses manually for users. If any of the licenses that are defined in the
mappings became unavailable during the synchronization process (not enough license), licenses will
not be assigned to the users. Therefore, ensure that there is enough licenses before creating the
mappings.

You can run automations either on the device which is set as your bot running device or from a
device pool for which you have consumer privileges (Create a user ). When using Active Directory role
mapping, if you want any mapped Active Directory user to be able to use more than one device, you
must configure a device pool (Create device pools).

13. Click Create Mappings.

When the synchronization runs, all users with the assigned roles are updated.

Edit Active Directory role mapping
As an Automation Anywhere Control Room administrator, edit the Active Directory security group mappings
assigned to roles in the Control Room.
Ensure that you are logged in to the  as the administrator.
Ensure that the mapping name is unique and cannot be duplicated. If you rename a map with an existing
mapping name, an error message appears stating that the same name already exists. Changes to mapping
name or roles are updated in the audit log.
1. Vai a Amministrazione > Ruoli.
2. Click Active Directory Role Mapping.
3. Hover over the Actions icon for the role and select Edit role mapping.
4. Supply any required changes for Role Mapping.

Edit the roles by either adding or removing roles from the Available roles list, except Bot Insight
roles. If you assign Bot Insight roles, an error message appears stating that the role mapping cannot
be updated as it contains unsupported roles.
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Nota:  You cannot edit the rest of the fields. The process to update mappings and synchronize users
starts at a previously defined interval or when you manually update the mappings.

5. Fai clic su Salva modifiche.

When the LDAP sync runs, all users with the assigned roles are updated.

Delete Active Directory role mapping
An administrator or a user with permission to view and manage role can delete role mappings listed in the
Role Mapping table.
Ensure that you are logged in to the  as the administrator.
1. Vai a Amministrazione > Ruoli.
2. Click Active Directory Role Mapping.
3. Hover over the Actions icon for the role and select Delete role mapping.
4. Click Yes, delete.

Impostazioni
Utilizza la scheda Impostazioni per configurare la connessione a Credential Vault, abilitare le notifiche e-
mail, integrare Control Room con un archivio Git, abilitare la modalità di registrazione sicura e configurare
l'autenticazione utente.

Bots

• La modalità di registrazione sicura assicura che nei bots non siano archiviati i dati sensibili. Quando
la modalità di registrazione sicura è abilitata, i bots non acquisiscono i valori di alcune proprietà né
memorizzano immagini dell'applicazione. You can enable this setting for some or all users of the Control
Room.

Nota:  La modalità di registrazione sicura si applica solo ai bots che vengono creati o modificati dopo
che la modalità è stata abilitata.

Fai clic su Modifica nella scheda Bot per abilitare o disabilitare la modalità di registrazione sicura.
Consulta Registrazione sicura alla pagina 37.
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• La convalida del Bot esegue un'ulteriore convalida del tempo di compilazione sui bots migrati nella
fase di pre-elaborazione per risparmiare tempo e fatica. Per impostazione predefinita, la funzione di
convalida del Bot è impostata su Off.

Nota:  Devi essere un amministratore di Control Room per visualizzare e modificare l'opzione di
convalida.

Navigate to Administration > Settings > Bots and set the bot validation option to On to detect
compilation errors with bots.
La convalida avviene al momento dell'esecuzione del bot, per i nuovi bots. Per i bots migrati, questo
controllo viene eseguito immediatamente dopo la migrazione dei bot, secondo la configurazione.
Ad esempio, se un bot padre richiama un bot figlio e il bot figlio ha errori di compilazione, questi errori
vengono visualizzati quando si cerca di eseguire il bot padre. Questo assicura che un errore non si
verifichi nel mezzo di un'automazione o la renda incompleta.
Nella pagina dei risultati della migrazione dei Bot, seleziona un bot che deve essere rivisto. Fai clic sui
tre puntini sotto la scheda Motivo per vedere i dettagli. Con la funzione di convalida dei Bot impostata
su On, i bots che hanno errori di compilazione sono visualizzati come una voce di riga separata nel
rapporto di migrazione.
I bots migrati con errori di compilazione sono mostrati in Operazione riuscita con revisione del
rapporto di migrazione e ciò consente di ottenere una lista di bots che richiedono la tua attenzione.

Dispositivi

Quando risulta disponibile una nuova versione del Bot Agent, questo viene aggiornato automaticamente.

IQ Bot

Visualizza l'indirizzo del sito Web in cui IQ Bot è attualmente installato, se applicabile. Fai clic su Modifica
per aggiornare l'URL di IQ Bot.

E-mail

Tutti gli utenti devono confermare gli account e-mail facendo clic sul collegamento di conferma che
ricevono e impostare la password e le domande di sicurezza prima di poter accedere alla Automation
Anywhere Control Room. Per impostazione predefinita, le notifiche via e-mail sono disabilitate. Passare il
mouse sull'icona Modifica per apportare modifiche.
Modifica notifiche via e-mail alla pagina 2750

Integrazione Git

L'archivio Git remoto deve supportare Git LFS (Large File Support). I Bots vengono sincronizzati con il push
Git standard su HTTPS.
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Login settings

For security, privacy, or any other pertinent announcement, you can provide an additional statement, such
as consent text, in the Login settings section. The statement is visible to users every time they log in to
the Control Room.
This statement on the login page is disabled by default. If you enable it, you can also provide an option
(using a check box) for users to read and accept the statement before logging in to the Control Room.

Impostazioni di sicurezza

Password Personalizza i requisiti della password per tutti gli
utenti Control Room. La password deve includere
quanto segue:
• Un numero
• Un carattere alfanumerico
• Un simbolo
• Una lettera maiuscola

Per gli utenti di On-Premises: Le caselle di
controllo sono abilitate e l'utente può selezionare o
deselezionare le opzioni.
Per gli utenti di Cloud: Le caselle di controllo
sono disabilitate e l'utente non può selezionare o
deselezionare le opzioni.

API-Key duration The generated API-Key is used to authenticate
users. You can customize how long the generated
API-Key is valid to authenticate users until either:
• A selected duration is reached (in minutes or

days), or
• A new API-Key is generated

Nota:  You determine the validity duration based
on your organization's requirements. Maximum
supported API-Key duration is 1 to 14,398,560
minutes, or 1 to 9,999 days.

Impostazioni di disconnessione dalla sessione You can enable settings to automatically time out
users from the Control Room browser session
after the specified minutes of inactivity. You can
configure the inactivity time in the range of 10-60
minutes in the Time-out session setting field.
You can configure the session using increments of
10 minutes. The default value is 20 minutes, which
means you will be logged out of the session after
20 minutes of inactivity.

Impostazioni di caricamento file As an Administrator, you can restrict the upload of
executable files (dll files, media type application/x-
msdownload) to prevent a security breach. To use
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this feature, enable the File upload settings in
Administration > Settings > Security settings.

Notification settings

Manage the notification settings for notification categories and channels. The notification settings defined
by the Control Room administrator are applicable for all the Control Room users. Based on these defined
settings, Control Room users will be notified about the events.
Administer notifications for Control Room alla pagina 2923.

Autenticazione utente

Configure the Control Room to authenticate users through the database option or switch to a SAML Identity
Provider (IdP).
Configurazione dell'autenticazione SAML alla pagina 995

Archivio chiave esterno

External key vaults provide a way to securely store and retrieve credentials using a third-party key manager
such as CyberArk, Azure, and AWS Secrets Manager.
Attività correlate
Configurazione dell'autenticazione SAML alla pagina 995
Switch an authenticated environment Control Room database to a SAML identity provider (IdP).
Modifica notifiche via e-mail alla pagina 2750
Modifica i dettagli sul server e-mail da utilizzare per inviare le notifiche via e-mail.

Package updates
The delivery of packages is developed to be separate from the main platform updates. This will help us
respond quickly to changes and fixes required and provide the flexibility to deliver updates in packages,
going forward.
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A new package and new package version is downloaded and installed if it is compatible with your Control
Room version.
• Cloud users cannot turn off this automatic installation of a new package and new package version, but

the package administrator can control the status of the new package version.
• For On-Premises users, the automatic package download capability is disabled by default, but package

administrators can enable it.

Nota:  From Automation 360 v.27, the automatic package download capability is enabled by default for
any On-Premises new installation. As a package administrator, you can disable this feature.

This capability is enabled differently for Cloud and On-Premises Control Room instances, as listed in the
following table:

Seamless package update
capability

Cloud Control Room On-Premises Control Room

Download packages from
Automation Anywhere Cloud

Enabled by default and cannot
be disabled.

Disabled by default and can be
enabled.

Nota:  From Automation 360
v.27, it is enabled for new
installation and can be disabled.

Set downloaded package to
default version

Enabled by default and can be
disabled.

Enabled by default and can be
disabled.
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Nota:  After the Automation 360 v.27 upgrade, when a new package (first version) is added to the Control
Room and if the packages setting is set to Disable for the new version of the package, note that this
package will show the status as Enabled and set as default instead of Disable.

• Cloud users: Automatic package updates for Cloud Control Room alla pagina 2727
• On-Premises users: Aggiornamenti automatici del package per On-Premises Control Room alla pagina

2726

We recommend bot developers always use the latest version of the packages because that version
provides the latest innovations and all the code and security fixes from previous versions. Note that
this capability does not impact existing bots, which continue to run unchanged. Bots developed with a
particular package version will continue to do so unless explicitly changed by the bot developer. However, if
you want to modify existing bots to use the default version of a package, you can use the Update bots to
default package version feature. Per ulteriori informazioni, consulta Aggiornamento dei bots alla versione
predefinita del package alla pagina 2651.

Aggiornamenti automatici del package per On-Premises Control Room
Configura le impostazioni On-Premises della Control Room per richiedere gli aggiornamenti del package dal
Cloud automaticamente o solo se la Control Room viene aggiornata manualmente.
Semplificare la funzione di aggiornamento package fa parte del nostro impegno volto a rendere
immediatamente disponibili le innovazioni e i miglioramenti. Questa funzionalità della piattaforma
Automation 360 fornisce un accesso prevedibile, qualitativo e non distruttivo alle innovazioni e ai
miglioramenti più recenti.
Se la funzionalità di aggiornamento semplificata è abilitata, la Control Room può scaricare nuovi packages
e le nuove versioni dei packages esistenti dal Automation Anywhere Cloud quando vengono rilasciate
con una cadenza regolare e prevedibile. Le versioni appena scaricate package sono automaticamente
impostate come predefinite packages per consentire ai clienti di iniziare a usare queste versioni del
package su base continuativa, non appena i packages sono disponibili.

Nota:  To automatically download newly released package versions, the Control Room uses the following
URL and port number:
• URL: https://aai-artifacts.my.automationanywhere.digital/packages/<package-

jar-file-name>
• Port number: TCP 443 (HTTPS)

Nota: questa funzionalità non ha alcun impatto sui bots esistenti. I bots esistenti continuano a funzionare
senza modifiche. Queste nuove versioni del package sono anche retrocompatibili con la versione della
piattaforma esistente.

Configurazione dei packages per On-Premises

Assicurati di aver eseguito l'accesso alla On-Premises Control Room come amministratore.
1. Naviga su Amministrazione > Impostazioni > Pacchetti.
2. Modifica l'opzione Pacchetti.

La pagina si apre in modalità di modifica.
3. Seleziona Attivato per scaricare e installare automaticamente i nuovi packages dal Automation

Anywhere Cloud nella Control Room.
Per impostazione predefinita, l'opzione Aggiorna automaticamente i pacchetti dal cloud è
impostata su Disattivato.
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Nota:  From Automation 360 v.27, this capability is On for the new installation of the On-Premises
Control Room.

Quando si attiva questa impostazione, il sistema controlla la presenza di nuovi packages ogni 12 ore e
li installa automaticamente se sono disponibili nuovi packages.

Nota:  Il nuovo package viene scaricato e installato solo se è compatibile con la versione della Control
Room in uso.

4. Enable the settings to set the status of the new package.
This is applicable for new packages downloaded from the Cloud and the Control Room upgrade. By
default, this setting is enabled and set as default.
• Enable and set as default: Select this option to automatically set the new version of a package

as the default version.
• Enable: Select this option to manually set the default version after the package update.
• Disable: Choose this option to automatically disable the new version of a package.

5. Salva le impostazioni.

Automatic package updates for Cloud Control Room
Configure the Cloud Control Room settings to get package updates from the Cloud automatically.
Ensure that you are logged in to the  as the administrator.
When a new package or a new package version is released in the Cloud, the package version will
automatically get installed on Control Room. This automatic installation of a new package version cannot
be turned off by cloud users and can only control the status of the new package version after it is installed.
1. Naviga su Amministrazione > Impostazioni > Pacchetti.
2. Modifica l'opzione Pacchetti. La pagina si apre in modalità di modifica.
3. Enable the settings to set the status of the new package.

• Enable and set as default: Select this option to automatically set the new version of a package
as the default version.

• Enable: Uploads and enables the package, but the package is not set as the default package. Bot
Creators have to specifically select non-default packages to use them for creating bots.

• Disable: Choose this option to automatically disable the new version of a package.

4. Salva le impostazioni.

Concetti correlati
Preload packages alla pagina 2004
You can preload packages on your local device to shorten the bot runtime.

Manage device settings
Control Room administrator can configure the device settings to automatically set a user's default device
when that user logs into Control Room.
Attività correlate
Configure screen resolution for a device session alla pagina 2730
For user devices, you can set the screen resolution of the Bot Runners for every bot deployment through
the RDP in the Control Room.

© 2023 Automation Anywhere. All rights reserved.     2727



    Automation Anywhere - Gestisci

Configure temporary devices alla pagina 2731
Configure your device settings to automatically delete a temporary device when the device is disconnected
from the Control Room after a certain time interval.
Configurare le impostazioni di soglia per i dispositivi utente alla pagina 2732
Configura l'utilizzo della CPU e i valori di soglia della memoria del dispositivo per controllare la distribuzione
simultanea di bot sui dispositivi utente in base all'utilizzo delle risorse.
Configure auto-login settings alla pagina 2732
Configure auto-login settings in the Control Room to either create user sessions or reuse existing user
sessions to reduce the bot startup time.

Configure general settings
Configure the default device setting for temporary or non-persistent devices so that users of such devices
users do not have to log in to the Control Room to mark their device as a temporary device.
1. Accedi a Amministrazione > Impostazioni > Dispositivi.
2. Click Edit in the General tab.
3. Per impostare automaticamente il dispositivo di un utente connesso come dispositivo predefinito,

verifica che l'opzione Abilitato sia selezionata.
L'opzione è selezionata per impostazione predefinita. Puoi modificarla in Disabilitato se non desideri
impostare il dispositivo di un utente connesso come dispositivo predefinito.

4. (Optional) While enabling users to switch Control Room
5. Fai clic su Salva modifiche.

Configure browser extensions
You can customize the browser extension settings for user devices at the device level. Customizing the
setting helps you to continue to use browser-based automations seamlessly even when there is an update
to the browser extension.
• You must be a Control Room administrator to configure this setting.
• You must have installed Bot Agent version 21.222 or later.
• You must have installed the Bot Agent with installation type as system-wide.

By default, the Google Chrome and Microsoft Edge browser extensions are enabled on all Bot Agent
devices. When this option is enabled, the browser extensions are automatically updated on all the
connected devices through a single click.
1. In the Control Room, navigate to Administration > Settings > Devices.
2. In the Browser extensions settings, select Edit and then select one of the following options:

• Enabled: Select this option to enable the Google Chrome or Microsoft Edge extensions on all the
connected devices.

• Disabled: Select this option to disable the automatic update of browser extensions. This option is
applicable only when a Bot Agent is upgraded or a new Bot Agent is installed.

• Force disable Chrome and Edge extensions from all bot running devices: Select this
option when you want to manually upgrade the browser extension.
This option disables browser extensions on all the Bot Agent devices.

Nota:  These settings on the browser extension depends on the ExtensionInstallForceList
group policy. None of these settings can be applied if the ExtensionInstallForceList group
policy with Automation Anywhere extension is not available in the system.
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Nota:  Selecting this option might disrupt the functioning of your browser-based automation.

Consider the following when configuring the browser extensions option:
• If the Browser extensions option is selected and you disable this option when the

Force disable extension on all bot running devices option is unselected, then the
ExtensionInstallForceList group policy is not applied on the devices that are newly
registered or upgraded. You will have to enable the extension manually on the newly registered or
upgraded devices.

• If the Browser extensions option is selected and you deselect it, with the Force disable
extension on all bot running devices option selected, the ExtensionInstallForceList
group policy is deleted from all the Bot Agent devices and you must manually update the browser
extension.

• If the Browser extensions option is unselected and you select it, the group policy changes are
pushed to all the Bot Agent devices.

Nota:  Automation Anywhere does not interfere with the ExtensionInstallForceList group
policy if it is already present on the system, However, if a key by name 1 is already present in the
ExtensionInstallForceList folder, create a key name with the subsequent number, in this case,
2. See ExtensionInstallForcelist for Google Chrome or ExtensionInstallForcelist for Microsoft Edge.

.

Configure log collection
The log collection configuration enables you to collect log entries from the devices connected to the
Control Room.
You can view the system log information on your device at the following locations:
• Bot Agent installed as admin user: C:\ProgramData\AutomationAnywhere\BotRunner\Logs
• Bot Agent installed as local user or non-admin user: %userprofile%\AppData\Local

\AutomationAnywhere\BotRunner\Logs

.
The following logs are collected:
• Node manager logs
• Bot launcher logs
• Browser extension logs

You can choose to collect one of the following log-level information:

Nota:  In the production (PROD) environment, we recommend that you set the log file configuration level
to INFO for optimal performance.

• Info (default): Messaggi informativi che evidenziano l'avanzamento dell'applicazione
• Debug: Fine-grained information that is useful for debugging an application
• Trace: Captures every behavior of the application in detail

1. Accedi a Amministrazione > Impostazioni > Dispositivi.
2. Click Edit in the Log collection configuration tab.
3. To configure the level of log collection, select Info, Debug, or Trace.
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4. Set the maximum log file size between 1 MB and 100 MB.
5. Set the maximum number of log files between 1 and 500.
6. Salva le impostazioni.

Configure screen resolution for a device session
For user devices, you can set the screen resolution of the Bot Runners for every bot deployment through
the RDP in the Control Room.
Questa attività viene eseguita dall'utente che desidera creare e distribuire . Devi disporre dei diritti e delle
autorizzazioni necessarie per completare questa attività, nonché dell'autorizzazione per accedere alla  come
utente con licenza.
The RDP session is created using the set screen resolution during bot deployment.
1. Accedi a Amministrazione > Impostazioni > Dispositivi.
2. Edit the Resolution settings for a device session field.
3. Set the resolution by either selecting a predefined value from the Screen resolution drop-down list

or by selecting Custom and entering the values you want.
Note that the screen resolution settings are applicable only when you use RDP-based deployments.
For regular deployments, a Windows session is created using the existing resolution settings of the
device. In this case, the screen resolution set in the Control Room is ignored.

Nota:  When resolution dependent packages are used to build bots, any screen resolution difference
between the Bot Creator and Bot Runner device will impact the bots during runtime. Therefore, ensure
the resolution settings on devices match when you create and run bots. Consulta Screen resolution
dependent packages alla pagina 2730.

4. Select the Do not allow devices to override resolution settings option.
When you select this option, the resolution settings cannot be changed at the device level.

5. Fai clic su Salva.

Screen resolution dependent packages
The screen resolution between the Bot Runner and Bot Creator device should be consistent as when
resolution-dependent packages are used to build bots, any screen resolution difference between the Bot
Creator and Bot Runner device will impact the bots during runtime.
Ensure the resolution settings on Bot Creator and Bot Runner devices match when you create and run
bots. Review the table given below for information on the resolution-dependent packages and their
attributes.
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Pacchetto Effects of display parameter changes Resolution-
dependent
attributes

Image Recognition If we use the Image Recognition package in a
computer that has a different resolution, scaling, or
zooming than the resolution that was configured in
the system, it can affect the output as it works on
image pixel values and the features.
For RDP machines, when you configure Image
Recognition package in a different machine and
run it on an RDP machine with same resolution and
scaling, and if RDP is using a different display driver,
the capture might not be accurate. It can render
image with slightly different pixel values that can
cause a reduction of matching percent.

X, Y, width, and
height

Mouse The Mouse > Click action requires X and Y co-
ordinates to capture the UI element. If there is a
change in screen resolution, scaling, or zooming, the
coordinates might move, and it might click different
coordinates. Due to this, the Click action will fail
to capture the specific UI element. If you are using
the RDP machine with the same resolution, scaling,
or zooming then it will not create any issue as the
Mouse package does not depend on the pixel value.

X, Y

App Integration The App Integration > Capture area action
requires X and Y co-ordinates to capture the text
from a window. Any change in screen resolution,
scaling, or zooming might cause change in the
coordinates, and the correct text is not captured. In
the RDP machine, use same resolution, scaling, and
zooming so that you do not encounter any issues.

X, Y, width, and
height

Screen The Screen > Capture area action requires X
and Y co-ordinates to capture the screenshot of the
application window area. Use the same resolution
and scaling in the RDP machine so that the output is
not affected.

X, Y, width, and
height

OCR The OCR > Capture area action uses the X and
Y co-ordinates to extract text from a specified area
in the selected window. Ensure you have the same
resolution, scaling, and zooming in the RDP machine
so that extraction of the text is not affected.

X, Y, width, and
height

Configure temporary devices
Configure your device settings to automatically delete a temporary device when the device is disconnected
from the Control Room after a certain time interval.
Ensure that you are logged in to the  as the administrator.
1. Accedi a Amministrazione > Impostazioni > Dispositivi.
2. Edit the Temporary devices - auto delete settings.
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3. Use plus (+) or minus (-) to select the number of Days, Hours, or Minutes to wait before the
temporary device should be deleted automatically.
The default time is 24 hours.
You can also manually delete the temporary device from the My devices page in the Control Room.

4. Salva le impostazioni.

Configurare le impostazioni di soglia per i dispositivi utente
Configura l'utilizzo della CPU e i valori di soglia della memoria del dispositivo per controllare la distribuzione
simultanea di bot sui dispositivi utente in base all'utilizzo delle risorse.
Ensure that you are logged in to the  as the administrator.
In base all'utilizzo della CPU e ai valori di soglia della memoria del dispositivo, è possibile stabilire se
distribuire i bots sui dispositivi utente. Se il valore di soglia è uguale o superiore al valore fornito, i bots non
vengono distribuiti sui dispositivi utente.
I valori predefiniti per l'utilizzo della CPU e la memoria del dispositivo si basano sui seguenti parametri:
• Quando la frequenza di raccolta dei dati è di 10 secondi, il sistema raccoglie 6 punti dati in 1 minuto.
• Quando l'intervallo di tempo per il caricamento dei dati è di 120 secondi, il sistema carica 6 punti dati

sulla Control Room ogni 2 minuti.
• Quando la finestra temporale media mobile è di 2 minuti, il sistema utilizza gli ultimi 12 punti dati per

calcolare l'utilizzo medio delle risorse.

1. Accedi a Amministrazione > Impostazioni > Dispositivi.
2. Modificare le Impostazioni di soglia per dispositivi multiutente.
3. Ottimizza il comportamento di sessioni simultanee scegliendo una delle seguenti opzioni:

• Non abilitare impostazioni di soglia
Utilizza questa opzione per la distribuzione di bots su dispositivi a singolo utente.

• Abilita le impostazioni di soglia per impostare i valori massimi:
a. Immetti la frequenza di utilizzo della CPU e della memoria per la raccolta dei dati.
b. Immetti l'intervallo di tempo per caricare i dati.
c. Immetti la finestra temporale media mobile.
d. Immetti il limite di soglia della CPU per la distribuzione di nuovi bot su un dispositivo.
e. Immetti il limite di soglia della memoria per la distribuzione di nuovi bot su un dispositivo.

Utilizza questa opzione per la distribuzione su dispositivi multiutente.

Puoi immettere i valori o fare clic sui segni più (+) o meno (-) per aumentare o diminuire il limite.
4. Salva le impostazioni.

Configure auto-login settings
Configure auto-login settings in the Control Room to either create user sessions or reuse existing user
sessions to reduce the bot startup time.
Ensure that you are logged in to the  as the administrator.
Auto-login enables you to deploy a bot for unattended Bot Runners after automatically logging on to a
machine and restoring the machine to its original locked/unlocked state after completing the deployment.
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Nota:  The Run as user device credentials are used for Auto-login.

Configure auto-login settings to either create new user sessions or reuse existing sessions in the following
scenarios:
• Before deploying a bot, some applications are kept running to accommodate a delay in the application

launch.
• When Windows updates or Active Directory policy updates are pushed after a user logs in, changes in

the automation environment might affect bot execution.
• Logging off from temporary or non-persistent devices stops bot execution.
• You can reuse existing user sessions when your company's IT policy prevents you from providing device

user password for auto-login credentials.
• To bypass legal disclaimers on RDP-based deployments.

1. Accedi a Amministrazione > Impostazioni > Dispositivi.
2. Edit the Auto login settings.
3. Opzionale: External key vault setting.

4. Choose how to run bots on user sessions by selecting one of the following options:
• Always create a new session

Select this option for desktop deployments where it is possible to create user sessions on devices.
• Reuse an existing session

Recommendation:  Select this option for auto-login settings in the Control Room to use event
triggers on unattended Bot Runners and to run bots when a device is locked or is in a disconnected
state (such as RDP).

Available options to lock or unlock the session are:
• An existing locked session
• An existing unlocked session
• A disconnected session
• Allow users to change these settings for each device

Use this option for deployments on devices where it is not possible to create user sessions.

Nota:  When you use the Reuse an existing session option, ensure user sessions are available.
If there is no existing user session, triggers and bot deployments will fail.

• Reuse an existing session, if available
Use this option if you must create a new session or reuse an existing session. If a session does not
exist, create a new session and leave it unlocked for next user session after bots complete their run
from the following:
• A new session
• An existing locked session
• An existing unlocked session
• A disconnected session

5. To allow a user to change the auto-login settings at the device level, go to Administration > My
Devices and select Allow changes.
The Do not allow changes option disables the user-level auto-login settings for user sessions.

6. Salva le impostazioni.

© 2023 Automation Anywhere. All rights reserved.     2733



    Automation Anywhere - Gestisci

Riferimenti correlati
Dispositivi alla pagina 2628
Il dispositivo è una macchina attraverso la quale un utente si connette alla Control Room per creare o
eseguire bots. Manage devices that are registered to the Control Room through the Devices page located
in the Manage tab.

Configure advanced options
Configure the default settings for your device. For example, if you can change the default location of global
cache as per your requirement.
A Control Room administrator can use any of the following optional instructions to change the default
settings:
1. Accedi a Amministrazione > Impostazioni > Dispositivi.
2. Click Edit in the Advanced options settings.
3. Click Allow changes on the Edit device page to change the default settings and enable users to

make changes on the device page.
4. Enter a new filepath for global cache in the Global Cache Location field.

This option is available in the Control Room for all devices but can be used only by devices that have
the All Users/System Level (Recommended) option selected when installing the Bot Agent.

Nota:  Se il percorso specificato non è valido sul dispositivo, viene utilizzato il percorso predefinito.

5. Use the following fields to enter custom values:
• Autologin timeout: time duration within which a user can auto-login to the device.
• Bot launcher JVM options: send dynamic properties supported for Java.

For example, you can use this option to increase the memory of the bot launcher.
• Maximum simultaneous downloads: set the number of simultaneous downloads.

For example, 5 downloads including dependent files.
• Console readiness wait time: set a wait time for the console to be displayed when you run a

bot.
• Bot response wait time: set a wait time for an active bot session.
• RDP command options: provide different RDP-based commands.

For example, ports-related commands.
• Log collector: allows the device to send logs to Control Room.

6. Fai clic su Salva modifiche.

Commutare la registrazione del dispositivo tra istanze di Control Room
Configura le impostazioni del dispositivo in Control Room per consentire ai dispositivi monoutente di
passare facilmente da un'istanza all'altra di Control Room per eseguire bots in più ambienti. Questa
opzione consente di registrare Bot Agent su più istanze di Control Room e passare a un'altra istanza senza
reinstallare Bot Agent.
Ensure that you are logged in to the  as the administrator.
• È necessario disporre dell'autorizzazione Visualizza e gestisci TUTTI i dispositivi per abilitare l'opzione di

commutazione.
• È necessario attivare l'opzione di commutazione su entrambe le istanze di Control Room.
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• Puoi passare da un'istanza all'altra di Control Room solo se le istanze appartengono alla stessa build.
Ad esempio, se un'istanza Control Room è su Build 9664 e un'altra istanza è su Build 8815, non è
possibile commutare il dispositivo utente tra le due istanze Control Room. Entrambe le istanze devono
appartenere a Build 9664 o Build 8815.

1. Accedi a Amministrazione > Impostazioni > Dispositivi.
2. Modifica le impostazioni Generali.
3. Select Enabled to enable the local device as the default bot running device after a user logs into the

Control Room.
4. Select Enabled to enable a single-user device to be switched to another Control Room without

reinstalling the Bot Agent.
Additionally, the Allow fast switching option allows you to switch the Bot Agent with a single click.

Nota:  Fast switching is recommended only if there is no change in the network configuration when
connecting to a new Control Room. The first time you switch the Bot Agent to a new Control Room,
the device lifespan information (that is, whether the device is Persistent or Temporary) is copied
over to the new Control Room. No other configuration information is copied over.

If this setting is not enabled, you must uninstall Bot Agent first and then reinstall it to switch device
registration to different Control Room instances.

5. Opzionale: For additional security, you can enable the following setting in the Validate device
credentials field to validate the device credentials prior to bot deployment:
• Device credentials for all users: Validates the device credentials for Bot Creator, attended Bot

Runner, Citizen Developer, and unattended Bot Runner users.
• Device credentials for un-attended bot runner users only: Validates the device credentials

for unattended Bot Runner users only.

6. Salva le impostazioni.
7. Log in as a Bot Creator user to a Control Room configured in a different environment to verify that

users can switch between instances.
The Connect device option is available when you click the device icon in the Control Room panel.

Attività correlate
Switch Bot Agent to a different Control Room alla pagina 1045
Switch the Bot Agent on a registered device to work with a different Control Room manually when you
work on automations using different environments.

Add access IP addresses
Use this setting to limit user login access to the Control Room URL based on IP addresses or subnets that
you specify in a list. You add IP address ranges using the Classless Inter-Domain Routing (CIDR) format,
and you can add multiple CIDR ranges.

Nota:
If a user attempts to log in to the Cloud Control Room using an IP address that is not included in the
access list, an error message displays indicating invalid user or user credentials.

Ensure that you are logged in to the  as the administrator.
You must have access to Administration > Settings page with view, add, or edit permissions.
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Specify a list of IP addresses or IP subnets to permit access to the Cloud Control Room URL and API. If
your network egress uses dynamic IP addresses, then the ranges you enter must include the entire range
of dynamic IP addresses that can be assigned outbound traffic. For example, to specify a single IP address
use, 10.10.10.12/32; or to specify an IP address range, use 192.168.20.0/24.

Nota:  When using SAML for authentication, use the network access capabilities of the Identify provider
to restrict access to specific allowed IP addresses. Ensure all allowed IP addresses configured are removed
before switching to SAML for authentication. For more information, please consult Unable to Set up SAML
authentication for Control Room (A-People login required).

Perform the following steps to add an IP address or subnet to the list of permitted network access
addresses:
1. Log in to the  as the administrator.
2. Navigate to Administration > Settings > Network settings.
3. Click Edit to add to or edit the listed IP addresses.

Nota:  There is a limit of 25 independent entries in the access permitted table. An entry can be a
single IP address or an IP subnet.

4. Enter the IP address information:
Opzione Descrizione

Indirizzo IP singolo Enter the necessary IP address in x.x.x.x format.

Intervallo di indirizzi IP Enter the address in x.x.x.x format and specify
the subnet mask.

5. Inserisci il Nome.
6. Opzionale: Immetti una descrizione.
7. Fai clic su Salva modifiche.

Riferimenti correlati
Add IQ Bot cloud server IP addresses to allowed list alla pagina 835
To ensure seamless connectivity of your IQ Bot cloud servers with the Cloud Control Room, specify a list or
range of IP addresses that are allowed to access the Cloud Control Room URL.
Add Automation 360 Cloud URLs to trusted list alla pagina 831
To ensure secure access to Automation 360 cloud services, add the URL specific to the service to the safe
recipients or trusted list.

Set callback URLs
You can specify valid callback URLs, enabling the Control Room to post the results of the task execution
only to defined and secure URLs for more granular security over the network.
Ensure that you are logged in to the  as the administrator.
As a Control Room administrator, you can configure and audit specific, permitted URLs for more granular
control of the network access points. Only the Callback URLs can be used in bot deployment APIs.
1. Navigate to Administration > Settings > Network settings > Deployment settings >

Callback URL.
2. Click the Edit icon. ( )
3. Add the required URLs.

Use the Add option for more URL fields.
4. Fai clic su Salva.
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Configurazione dell'autenticazione SAML
Switch an authenticated environment Control Room database to a SAML identity provider (IdP).

Nota:  L'integrazione SAML è irreversibile. After it has been established, you cannot modify the
configuration.

Ensure that you are logged in to the  as the administrator.
Before you set up authentication for the Control Room, setup tasks (such as introducing credentials on
a new system and importing users) might be required. If you import users, then you must also include
matching user IDs, email addresses, first and last names, in both the Automation Anywhere credentials
and matching records to log in after the SAML integration. For example, if using Okta as a SSO, then users
must have matching IDs, email addresses, first name and last names in both Automation Anywhere and
Okta to log in after the SAML integration.
You should have the required user information and certificate ready. Typical user information consists of
user ID, first and last name, and an email address.

Nota:  You must validate the SAML IdP setup before you configure the Control Room. Consulta Configure
the Control Room as a service provider alla pagina 979.

After switching to SAML authentication environments, any users with non-SAML IdP formatted IDs will not
be able to log in. You need to verify that any bots located in their private folders are exported so they can
be imported back against their new user accounts.
Much of this configuration relies on third-party applications to create the necessary metadata. If
you require more specific configuration information based on a specific provider, see Configure SSO
authentication with Okta alla pagina 996.
To switch the Control Room to a SAML-authenticated environment, follow these steps.
1. Navigate to Administration > Settings > User authentication.
2. Seleziona l'opzione Utilizza SAML.

Nota:  L'opzione Usa database Control Room è selezionata per impostazione predefinita.

3. Nel campo ID Unique Entity per la control room (provider di servizi), inserisci un ID entità
valido.

4. Nel campo Crittografa asserzioni SAML, seleziona una delle seguenti opzioni:
Opzione Descrizione

Non crittografare Le asserzioni SAML non sono crittografate.

Crittografa Le asserzioni SAML sono crittografate.

5. Opzionale: Inserisci i valori Chiave pubblica e Chiave privata.

Nota:  Inserisci le chiavi solo se sono necessarie asserzioni SAML crittografate.

6. Fai clic su Convalida impostazioni SAML.
The Control Room will log in through the SAML provider and redirect back to the Control Room User
Authentication page.
Quando selezioni questa opzione, sarai reindirizzato a una pagina web del provider di servizi SAML 2.0
dove ti verrà richiesto di immettere le credenziali e altri dati.

7. Log in to your provider when prompted.
8. Fai clic su Salva modifiche.
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Attività correlate
Configure the Control Room as a service provider alla pagina 979
A valid SAML IDP setup must be configured before the Control Room can be switched to a SAML-
authentication environment.

Autenticazione a due fattori
L'autenticazione a due fattori (2FA, Two-factor authentication) fornisce un ulteriore livello di difesa
contro l'accesso alla Control Room da parte di utenti non autorizzati. L'amministratore può impostare
l'autenticazione a due fattori in modo che gli utenti possano convalidare la propria identità quando
accedono alla Control Room utilizzando le proprie credenziali utente e un secondo fattore di autenticazione.

Come funziona l'autenticazione a due fattori

L'autenticazione a due fattori è un meccanismo di autenticazione aggiuntivo del processo di accesso.
L'autenticazione a due fattori è disattivata per impostazione predefinita. L'amministratore della Control
Room configura l'autenticazione a due fattori per tutti gli utenti o per gli utenti con ruoli specifici. Una volta
abilitata, l'autenticazione a due fattori è applicabile a tutti gli utenti Control Room a cui è destinata.
Quando ti viene assegnato un ruolo che richiede l'autenticazione a due fattori, devi configurare
un'applicazione Authenticator sul dispositivo mobile e stabilire una connessione tra l'applicazione
Authenticator e Control Room. Ai successivi accessi, ti verrà richiesto di inserire, insieme al nome utente
e alla password, una password monouso a tempo (TOTP) dall'applicazione Authenticator per completare
l'accesso alla Control Room.

Nota:  2FA is not supported for Control Room setup using Active Directory (AD) or SSO. 2FA is supported
only when the Control Room is the authentication provider.

Componenti

L'autenticazione a due fattori si avvale di tre componenti principali.
• Applicazione Authenticator: installata sul dispositivo mobile, questa applicazione genera una

password TOTP per la verifica dell'identità. È supportata qualsiasi applicazione di autenticazione che
supporti il protocollo TOTP, come DUO o Google Authenticator.

• Dispositivo registrato: il cellulare o un altro dispositivo registrato nella Control Room durante
il primo accesso dopo l'impostazione dell'autenticazione a due fattori. La password TOTP viene
generata attraverso questo dispositivo registrato, necessario ogni volta che si accede alla Control
Room. Se smarrisci il dispositivo registrato o il dispositivo registrato non è disponibile, devi chiedere
all'amministratore della Control Room di eliminarlo per aggiungerne un altro in un secondo momento.
Pertanto, si consiglia di configurare più di un dispositivo e di registrarli nella Control Room.

• Password monouso a tempo: Password temporanea generata da un algoritmo che utilizza l'ora
corrente del giorno come fattore di autenticazione.
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Impostazione dell'autenticazione a due fattori

1. Abilita l'autenticazione a due fattori nella Control Room.
a. Accedi alla Control Room come amministratore.
b. Navigate to Administration > Settings > Security settings > Two factor authentication.
c. Fai clic su Modifica per configurare le impostazioni.
d. Seleziona Abilita. Questa opzione non è abilitata per impostazione predefinita.
e. Scegli le impostazioni in base alle tue esigenze:

Opzione Azione

Tutti gli utenti Seleziona questa opzione per abilitare
l'autenticazione a due fattori per tutti gli
utenti che hanno accesso alla Control
Room.

Ruoli selezionati Per abilitare l'autenticazione a due
fattori per gli utenti con ruoli specifici:
1. Dalla colonna Ruoli disponibili,

cerca e seleziona i ruoli per i quali
desideri abilitare l'autenticazione a
due fattori.

2. Sposta questi ruoli nella colonna
selezionata.

f. Salva le modifiche.
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2. Facoltativo: se il dispositivo (mobile) registrato da un utente non è disponibile o è stato modificato,
elimina il dispositivo e registrane uno nuovo.
a. Accedi alla Control Room come amministratore.
b. Accedi ad Amministrazione > Utenti.
c. Seleziona l'utente che desideri modificare. Passa il mouse sul menu azioni (puntini di sospensione

verticali) a destra del nome e fai clic su Visualizza utente.
d. Nella sezione Authenticators seleziona il dispositivo da eliminare, fai clic sull'icona di

eliminazione e conferma l'eliminazione.

3. Imposta un'applicazione Authenticator e stabilisci una connessione tra l'applicazione Authenticator e
l'applicazione Control Room.
a. Accedi a Control Room come Citizen Developer o Bot Creator (Sviluppatore RPA).

Assicurati di aver impostato un'applicazione Authenticator sul vostro dispositivo mobile. Durante il
primo accesso, viene visualizzato un codice QR.

b. Esegui la scansione del codice QR utilizzando l'applicazione Authenticator o inserisci manualmente
il codice visualizzato nell'applicazione Authenticator.

c. Inserisci il nome dell'Authenticator e il nuovo codice generato nell'applicazione Authenticator.
Si tratta di un codice temporaneo che viene aggiornato dopo pochi minuti in base all'applicazione
Authenticator.

d. Fai clic su Conferma.
Segui le fasi successive del flusso di accesso, modifica la password e imposta le domande di
sicurezza. L'accesso alla Control Room è stato effettuato correttamente. Per gli accessi successivi,
devi inserire il codice generato nell'applicazione Authenticator e confermare.

4. Facoltativo: puoi gestire (aggiungere o eliminare) il dispositivo Authenticator.
a. Accedi a Control Room come Citizen Developer o Bot Creator (Sviluppatore RPA).
b. Nella Home page fai clic sul tuo nome utente.
c. Accedi a Le mie impostazioni > Autenticazione a due fattori.
d. Fai clic sull'icona col segno più (+).
e. Esegui i passaggi 3.b alla pagina 2740 attraverso 3.d alla pagina 2740.
f. Facoltativo: seleziona il dispositivo che desideri eliminare, fai clic sull'icona di eliminazione e

conferma l'eliminazione.

Configure Credential Vault Connection mode
Credential Vault is a centralized location for securely storing credential information used by bots.
Configure the Connection mode to connect to the Credential Vault using a Master key.

Nota:  Provide this key every time you start or restart the Control Room.
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To configure settings for Credential Vault, select Express or Manual mode.

Modalità Express Auto connect to the Credential Vault with the
master key that is stored in the system during
Control Room configuration.

Modalità Manuale Use this to manually connect to the Credential Vault
using the master key that was available during
Control Room configuration.

When switching modes, provide the Master Key in the field and click Save for the changes to take effect.

Suggerimento:  Restart the server machine (on which the Control Room is installed) or services to allow
changes to take effect.

All updates to the Credential Vault Connection mode are captured in the Audit Log.
• If you are facing Credential Vault connection issues while accessing the Control Room URL, see CR fails

to load with the Error Code 'cv.validation.secure.cv.locked' (A-People login required).
• If the Credential Vault is configured to connect to the Control Room in Manual mode, and the Master

Key is not added within a certain time period (for example, within 2 minutes), the devices might
disconnect from the Control Room.
Per ulteriori informazioni, consulta Bot agent device status remains disconnected post restart of Control Room
server after windows maintenance (A-People login required).

Attività correlate
Set up locker and assign credentials alla pagina 2841
Create a role, credentials, and locker to share related sensitive values with a group of users, so they can
use those values to build or run bots.

Editing SQL user information
Edit MS-SQL configuration related settings, including username, password, database server name,
database server IP and port numbers.
To perform the task, you must have a  administrator account with the required rights and permissions.
Download the latest Control Room utility and make certain this utility installed on every sever where
Automation 360 is running.

Nota:

Users are required to make changes to the running configuration via the command line interface.

Nota:  Please stop all Automation 360 services on all nodes where a Control Room is installed before
performing this task.

1. Open the command line prompt and navigate to the Automation 360 application.
For example, C:\Program Files\Automation Anywhere\jdk11\bin.

2. Follow the prompts from the utility to select the SQL database and enter the required credentials.

Nota:  The password will not be displayed on the console

3. Restart the Automation 360 services on the nodes.
The SQL user information has been successfully updated.
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Syslog server integration
The Automation Anywhere Control Room supports ingesting tenants' audit log entries in Syslog format to
any Syslog server.

Importante:  The options to specify or modify the Syslog configurations are available only for the On-
Premises deployment.

By pushing syslog data to a Syslog server, you can integrate and leverage the advanced searching and
reporting features of Syslog server solutions. When configured, the Control Room audit logs are forwarded
to both the Transmission Control Protocol (TCP) and User Datagram Protocol (UDP) network protocols. You
can use any syslog server. The following syslog servers are tested and certified by Automation Anywhere:
• Kiwi Syslog Server
• Splunk

You can configure a Kiwi Syslog Server or a Splunk server that accepts data from a Control Room
instance's syslog through a TCP or UDP port. The following example illustrates sending the Syslog data to
Kiwi Syslog server through TCP or UDP ports.

Configure Kiwi Syslog Server

Solarwinds Kiwi Syslog Server is a widely used commercial Syslog server. Kiwi Syslog Server Free Edition
can monitor Syslog for up to five devices. Download Kiwi Syslog Server Free Edition from the following link:
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Kiwi Syslog Server Free Edition. After installation, perform the following steps to configure the Kiwi Syslog
Server:
1. Navigate to File > Setup > Inputs.
2. To forward the logs through UDP, click UDP.

3. Enter the UDP port and the IP to which you want to forward the logs.
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4. To forward the logs through TCP, click TCP.

5. Enter the TCP port and the IP to which you want to forward the logs.

Configure Control Room to send Syslog on UDP or TCP

To configure the Control Room to send Syslog on UDP or TCP, perform the following steps:

Nota:
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To perform the task, you must have a  administrator account with the required rights and permissions.

1. Navigate to Administration > Settings > Network settings.

2. Click the Edit icon. ( )
3. To add more Syslog servers, click the plus (+) sign.
4. Inserisci le informazioni sul server Syslog.

Opzione Azione

Nome host del server Syslog Fully qualified domain name (FQDN) or the
IP address of the Syslog server to deliver
the log reports.
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Opzione Azione

Porta È la porta che il server Syslog remoto utilizza
per ricevere i record Syslog in entrata (ad
esempio, porta 514).

Protocollo TCP o UDP.
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Opzione Azione

Usa connessione sicura Consente di utilizzare un canale crittografato
TLS per inviare i record Syslog al server
remoto. Questa opzione è disponibile solo
per il protocollo TCP.

a. To forward the logs to a UDP port, enter the UDP settings (IP, port, and select UDP from
Protocol drop-down).

Nota:  For information about specific settings, see the Kiwi Syslog Server documentation.
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b. To forward the logs to an TCP port, enter the TCP settings (IP, port, and select TCP from
Protocol drop-down) .

5. Fai clic su Salva modifiche.

Verifying data in the Syslog Server

Reception of logs is verified in the Syslog Server. Perform the following steps to verify the data in Syslog
Server:
1. Generate a Syslog event by logging in or logging out of the Control Room.
2. Verify the logs in the Kiwi Syslog Server.
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If you have configured Splunk Splunk as your Syslog server, then you will observe the syslog messages in
the Splunk.

Modifica notifiche via e-mail
Modifica i dettagli sul server e-mail da utilizzare per inviare le notifiche via e-mail.
Ensure that you are logged in to the  as the administrator.
Specifica i dettagli sul server e-mail che desideri utilizzare e gli eventi, quando deve essere inviata la
notifica e-mail. Per configurare le impostazioni E-mail, attieniti alla seguente procedura:
1. Navigate to Administration > Settings > Email.
2. Click the Edit icon. ( )
3. Seleziona Invia notifiche via e-mail.

Per impostazione predefinita, le notifiche via e-mail sono disabilitate. Puoi scegliere di non inviare una
verifica ("Ti diamo il benvenuto") agli utenti creati/modificati.

4. Specifica i dettagli del server che desideri utilizzare per inviare notifiche e-mail.
Opzione Descrizione

Da questo indirizzo e-mail Inserisci l'indirizzo e-mail che desideri utilizzare
per inviare notifiche e-mail.
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Opzione Descrizione

Server host delle e-mail Specifica il server e-mail che desideri utilizzare
per inviare notifiche e-mail.

Porta del server e-mail Specifica la porta del server e-mail che desideri
utilizzare per inviare notifiche e-mail.

Il mio server usa una connessione sicura
(SSL/TLS)

Seleziona l'opzione se il server utilizza una
connessione protetta.

Il mio server richiede l'autenticazione Selezionare l'opzione se il server richiede
credenziali per l'accesso, ad esempio per un
archivio credenziali esterno.

Specifica il Nome utente e la password che
desideri utilizzare per accedere al server.

Specifica le credenziali.

Importante:  Le opzioni per specificare o modificare i dettagli del server e-mail sono disponibili solo
per la distribuzione di On-Premises.

5. Select any or all of the following options to specify the events when an email notification must be
sent:
• L'utente avvia la procedura Password dimenticata dalla schermata di accesso
• All'utente, quando le sue informazioni vengono modificate
• All'utente interessato, quando viene attivato, disattivato o eliminato
• All'utente che ha avviato o programmato un TaskBot, quando l'esecuzione dello stesso

viene interrotta perché non riuscita
• All'utente che ha eseguito l'esportazione o l'importazione di un pacchetto BLM, quando

questo viene esportato o importato
• A checkin process fails

Importante:  Se l'opzione Richiedi verifica non è selezionata, viene inviata una notifica via e-mail
senza link di verifica all'ID specificato nella e-mail. Puoi accedere al sito Control Room senza verificare
l'ID e-mail e impostare le credenziali di accesso.

6. Fai clic su Salva modifiche.

Controllo delle versioni in Automation 360
Il controllo delle versioni ti aiuta a gestire le modifiche apportate ai file che includono TaskBots, documenti,
rapporti, script, file eseguibili e flussi di lavoro. Con il controllo delle versioni puoi monitorare le modifiche
alla logica dei bot.
Con il controllo delle versioni puoi identificare la versione di un bot che desideri modificare e confrontare le
modifiche recenti con quelle precedentemente apportate al bot. In qualità di amministratore della Control
Room, puoi configurare il controllo delle versioni nelle impostazioni della Control Room.
Automation 360 include funzionalità di controllo delle versioni che possono essere utilizzate
indipendentemente dal fatto che la Control Room sia integrata con Git. Esamina le funzionalità disponibili in
Automation 360 e Git.
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Controllo delle versioni in Automation 360

• Estrai e archivia in TaskBots: puoi estrarre una versione di un bot (versione 1) dallo spazio di
lavoro pubblico a quello privato, apportare le modifiche desiderate e archiviare il bot nello spazio di
lavoro pubblico. In questo modo viene creata una nuova versione (versione 2) del bot, che corrisponde
alla versione più aggiornata. Ogni volta che estrai, modifichi e archivi un bot viene creata una nuova
versione del bot che rappresenta quella più aggiornata.

Nota:  puoi eseguire la versione più aggiornata di un bot o la versione con l'etichetta di produzione.

Puoi tornare a una versione particolare di un bot selezionando Opzioni avanzate durante l'action
di estrazione per selezionare una versione specifica del bot da estrarre. Puoi anche selezionare le
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dipendenze da estrarre. Ciò ti permette di modificare una versione specifica di un bot e le relative
dipendenze. Il bot archiviato diventa la versione più aggiornata. Ad esempio, se la versione più
aggiornata di un bot è la versione 8 e desideri tornare alla versione 3, devi estrarre la versione 3 del bot
e archiviarla di nuovo, creando così la versione 9. Questa versione più aggiornata, identica alla versione
3, è ora disponibile nello spazio di lavoro pubblico per le operazioni bot.
Check in a bot alla pagina 1997 | Check out a single bot alla pagina 2000

• Etichetta TaskBot: puoi anche tornare a una versione specifica di un bot assegnando un'etichetta a
tale versione del bot. Puoi utilizzare questa etichetta per scegliere la versione con cui desideri eseguire
determinate operazioni bot. Con la versione scelta, puoi programmare, eseguire, mettere in coda,
esportare e attivare flussi di lavoro di sviluppo bot.
Assign label to a bot alla pagina 2006

• Visualizza cronologia TaskBot: puoi visualizzare la cronologia delle versioni dei tuoi TaskBots nello
spazio di lavoro pubblico. Con Visualizza cronologia puoi visualizzare la cronologia delle modifiche
apportate ai tuoi TaskBots e identificare le actions eseguite da un utente. L'elenco di tutte le versioni di
un bot è mostrato in ordine cronologico inverso. Le informazioni visualizzate comprendono il numero
di versione, il messaggio di archiviazione, la data e l'ora dell'archiviazione e il nome dell'utente che ha
archiviato la versione.
Visualizzare la cronologia delle versioni di TaskBot alla pagina 2005

• Confronta versioni: puoi confrontare due versioni qualsiasi dei tuoi TaskBots per visualizzare le
differenze.
Compare bot versions alla pagina 2007

• Ripristina bots da Git: anche se la tua Control Room non è integrata con Git, puoi ripristinare i bots
da Git allo spazio di lavoro pubblico. Ad esempio, se hai 50 bots nel tuo spazio di lavoro pubblico e 75
bots in Git, puoi ripristinare i 25 bots rimanenti da Git nel tuo spazio di lavoro pubblico.

Nota:  This restore option is available only for On-Premises deployments and not supported on Cloud
deployments.

Controllo delle versioni con Git

Se la tua Control Room è integrata con Git, tutte le versioni dei bots e i file in Automation 360 sono
sincronizzati con Git ed è possibile utilizzare le seguenti funzionalità aggiuntive:
• Integrazione con un ramo Git
• Integrazione con Git tramite autenticazione SSH
• Integrazione con Git tramite server proxy
• Ripristino di bots o file in un archivio pubblico vuoto da una configurazione Git esistente
• Configurazione force push in fase di connessione a Git

Integrating Control Room with Git repositories alla pagina 2753

Integrating Control Room with Git repositories
Git integration with the Control Room ensures one-to-one mapping of the bots checked in to the public
workspace of the Control Room and the remote Git file structure. Git commits enable you to enforce
security, compliance, and code standards, and ensures that an organization's established best practices can
be applied to their bot development processes.

The Control Room has Git Client that is connected to the Git repository that stores the file history of your
public workspace. Each time a bot developer performs a bot check-in:
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• The bot and the dependent files are checked in to the public workspace.
• The Control Room creates a commit that contains all the contents of the particular check-in within the

Git repository.
• The comment entered in the check-in process is used as the Git commit message and the user details

are recorded as the author of the Git commit.
• The Bot definitions are stored as JSON files in the Git repository.

Nota:  The Git repository must be configured to have write access only to the Control Room and not to
any other Git client.

Supported Git repositories

You can configure the Control Room to replicate the built-in Git repository with the remote Git host, and
synchronize information using Git push. The following sources are certified for Git integration with the
Control Room.
• GitHub
• BitBucket
• Azure DevOps

Configure HTTPS (username and password authentication) between the Control Room and the remote Git
host. The Control Room and remote Git host use standard Git push protocol over HTTPS to send or receive
data.
Exposing the files to your remote Git host enables you to review the bot code and files using third-party
comparisons and static code analysis tools to help enforce compliance and maintain security standards.

Configure a remote Git repository in Control Room
Configure a remote Git repository in the Control Room so that you can version all the bots and their
dependencies and store them in the Git repository. In addition to the local Automation 360 repository in
the Control Room, the remote Git provides a backup for the bots and their dependencies.
• In order to configure a remote Git repository in the Control Room, ensure that you have the

AAE_Admin role.
• Based on your region, configure your network firewall to add outbound NAT gateway IP addresses to

the allowed list.
Automation 360 IP addresses for external integrations alla pagina 2757

Nota:
• The Git repository must be configured to have write access only to the Control Room and not to any

other Git client.
• You cannot upload files greater than 100 MB to the Git repository.

1. In the Control Room, navigate to Administration > Settings > Remote Git repository
integration.

2. Fai clic su Modifica.
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3. Choose one of the following authentication methods and perform the corresponding steps to set up
your Git configuration:
Metodo di autenticazione Fasi

Autenticazione HTTPS a. Enter the HTTPS repository path, including the
username in the following format:
https://<username>@bitbucket.org/
companyname/product.git

Nota:  Use the Git host that you want to obtain the
Git repository address.

b. Enter the branch name.
The changes are pushed to the branch selected. By
default, the master branch is selected.
You can use lower case characters for branch names,
but they must not exceed 250 characters. Do not
include ASCII control characters such as spaces,
tildes, or colons in branch names. You can use hyphen
to separate words. For more information on branch
naming, see Create a new Git branch.

c. Enter your Git repository password or a generated Git
token.

d. Inserisci nuovamente la password o il token Git per
confermare.
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Metodo di autenticazione Fasi

Autenticazione SSH a. Enter the SSH repository path in the following format:
https://git@bitbucket.org:companyname/
product.git

Nota:  Use the Git host that you want to obtain the
Git repository address.

b. Enter the branch name.
The changes are pushed to the branch selected. By
default, the master branch is selected.
You can use lower case characters for branch names,
but they must not exceed 250 characters. Do not
include ASCII control characters such as spaces,
tildes, or colons in branch names. You can use hyphen
to separate words. For more information on branch
naming, see Create a new Git branch.

c. Enter your SSH authentication private key.
You must create the private and public key pair by
using the RSA algorithm.

Nota:  Ensure that the private key entered in the
Control Room contains the following string: -----
BEGIN RSA PRIVATE KEY----- AND -----END
RSA PRIVATE KEY-----

You must generate the public key and enter it in your
Git server.
See the following topics for steps on how to generate
the public key depending on your server:
• Adding a new SSH key to your GitHub account
• Set up an SSH key to your BitBucket account

d. Facoltativo: Enter the passphrase.

4. Opzionale: Select the Connect to Git via proxy check box.
a) Enter the proxy host name or IP address.
b) immetti il numero della porta.
c) Opzionale: Select the authentication check box and enter the user name and password.

5. Fai clic su Connetti e salva.
The Control Room connects to the remote Git repository, and the following message is displayed: Git
integration settings successfully saved. You can also check the audit log where the
status for Set git settings is displayed as successful.
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Nota:  The check-in operation might take longer if you have many bot files in your Git folder in the public
workspace. This is because an increase in the repository size leads to a slowing down of the git commits.
As a best practice, we recommend you delete your bot files that are not used from your public workspace.

You can connect to the same Git repository with a different username in the Control Room. Per ulteriori
informazioni, consulta How to change the remote Git repository username in the control room (A-People login
required).

See the following video for an overview of Git:

Connect to Azure DevOps Git from Control Room
You can connect to Azure DevOps Git through the Control Room to check in and manage a bot and its
dependent files to the remote Azure DevOps Git repository. It creates a back-up for all your checked-in bot
and its dependent files on Azure DevOps.
• To connect to Azure DevOps Git from Control Room, ensure that you have the AAE_Admin role.
• Make sure that you have an Azure DevOps account.

1. Log in to the Azure DevOps account.
2. Create an Azure DevOps project. Provide a project name and description, select project visibility

(public or private), and then click Create.
3. Click Repos.
4. Click Generate Git Credentials. Enter the username and the password or token. When you obtain a

token to connect to Git, ensure that you have Read and Write permissions.
5. Copy the Git repository path without any changes to Admininistration > Settings > Git

integration > Configuration > Setup Git integration > Edit > Git repository path (including
username) in the Control Room and enter the password/token.

6. Fai clic su Connetti e salva.
7. To confirm whether your connection is successful, check in a file from the private repository to a public

repository and verify that your changes are pushed to Azure DevOps Git repository.

Remove Git integration configuration
If there is no longer a need to synchronize the bot information stored in your Control Room with the
remote Git host, you can remove or disable it.
Ensure that you have the AAE_Admin role assigned to you.
1. Navigate to Administrators > Settings > Git Integration.
2. In the Git Integration window, click Edit.
3. Select Do not set up Git integration.
4. Fai clic su Connetti e salva.

This setting removes the remote Git configuration, and the Control Room will no longer push the Git
history to the remote Git host.

Automation 360 IP addresses for external integrations
To ensure seamless connectivity of your Git instance, On-Premises key vault, or SIEM with the Cloud
Control Room, configure your network firewall to include Automation Anywhere outbound Automation 360
IP addresses to the allowed list.
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When you configure an Automation 360 Cloud deployment to connect to external systems or to capabilities
such as Git instance, On-Premises key vault, or SIEM with your Cloud Control Room, then you must
provide connections to those systems or services for the Automation 360 Cloud instance.
The Automation 360 server instance initiates the connection by using one of the listed Automation 360
IP addresses. As a result, you must configure these IP addresses in your network firewall and add the
regional outbound Automation 360 IP addresses to the allowed list.
The following diagram shows a typical Automation 360 Cloud deployment for external integrations:

Based on your region, add the following outbound Automation 360 IP addresses to the allowed list:

Regione IP addresses

- Africa • 13.244.57.44
• 13.244.197.159
• 13.244.185.72
• 54.228.5.1
• 54.228.48.30
• 54.217.103.248

- Australia • 54153153175
• 52.65.8.56
• 3.106.147.142
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Regione IP addresses

- Canada • 35.203.94.19
• 34.152.28.44

- EU West 1 • 108128188103
• 63.34.200.237
• 52.30.160.238
• 18.197.15.181
• 18.195.27.35
• 3.123.208.13

- EU West 4 • 35204101230
• 34141232185
• 34.141.55.27
• 34.141.57.227

India • 3.7.60.137
• 3.6.235.61
• 13.232.116.48
• 18.136.73.65
• 52.77.203.34
• 18.136.8.15

- Japan • 18177157130
• 18.176.174.19
• 3.114.196.205
• 54.169.202.27
• 52.221.25.42
• 18.140.96.19

- LATAM • 54.94.241.48
• 18.229.39.93
• 52.67.153.170
• 34.195.218.48
• 3.211.67.78
• 3.228.163.41

- Middle East • 15.185.153.52
• 15.185.181.122
• 157.175.32.98
• 52.213.112.204
• 54154112221
• 34.242.58.85
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Regione IP addresses

- Sandbox Australia • 34.151.71.179
• 35.189.24.10

- Sandbox EU West • 54.228.82.108
• 54.73.17.42
• 54.228.85.241
• 3.122.33.207
• 35.156.216.8
• 18.159.235.149

- Sandbox US West • 35164189142
• 35166154241
• 35.160.254.91
• 35.168.234.8
• 34.204.215.165
• 54.92.237.118

- Singapore • 18.141.71.43
• 54.251.139.55
• 18.136.253.184
• 18.176.165.62
• 52.68.115.49
• 54.168.135.182

- US Central • 34.85.131.101
• 35.245.151.203
• 34.68.252.217
• 34.123.71.95

- US East • 50.16.245.134
• 35.174.84.76
• 3.210.114.16
• 54.244.136.23
• 54.185.77.190
• 44.234.224.213

- US West • 54213119159
• 34.218.159.79
• 52.33.16.117
• 3.225.222.13
• 34.197.160.162
• 3.213.188.29
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Regione IP addresses

- Sandbox US Central • 35.223.219.53
• 34.133.80.165
• 34.150.165.212
• 35245150192

- Sandbox Singapore • 13251176239
• 54.169.33.175
• 46.137.201.87

Ripristino di bots da archivio Git
Se il database viene eliminato o danneggiato, l'utente può ripristinare tutti i bots e i file dipendenti associati
dall'archivio Git nel nuovo database. This restore option is available only for On-Premises deployments and
not supported on Cloud deployments.
Prima di ripristinare i bots da Git, verifica quanto segue:
• È necessario disporre di un backup dei bots su Git.
• Ti deve essere stato assegnato il ruolo AAE_Admin.

• Il processo di ripristino Git richiede alcuni tempi di inattività. Quando il processo di ripristino è in
esecuzione, le seguenti operazioni dell'area di lavoro pubblica sono disabilitate:
• Estrai
• Clona
• Esegui e programma i bots
• Esegui bots con coda
• Importa ed esporta bots

• Quando il processo di ripristino è in esecuzione, l'operazione di archiviazione non è consentita nell'area
di lavoro privata. Tuttavia, è possibile utilizzare l'area di lavoro privata per le restanti operazioni.

• È possibile ripristinare i bots in un archivio vuoto o non vuoto.
• Non è possibile interrompere un processo di ripristino in corso.

1. Log in to the Control Room as an admin user.
2. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
3. Click the Restore from Git option in the Public workspace.

Viene visualizzata la finestra di dialogo Ripristina da Git che mostra un avviso che indica che tutte le
operazioni dell'archivio pubblico saranno disabilitate durante il processo di ripristino Git.

4. If you have duplicate files in the Git repository, select to either Overwrite existing files or Skip
existing files in the Git repository.

5. A seconda che l'archivio sia vuoto o non vuoto, scegli una delle seguenti opzioni:
• Per ripristinare i file in un archivio non completamente vuoto, immetti le credenziali Git per

l'archivio associato.

Nota:  You cannot use the existing Git configuration for a partially filled repository.

• Per ripristinare i file in un archivio completamente vuoto, è possibile scegliere l'archivio Git da cui si
desidera ripristinare i file.
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Opzione Azione

Usa impostazioni di configurazione git
esistenti

Seleziona questa opzione per ripristinare i dati
dall'archivio Git configurato con la Control Room.

Nota:  Ensure you connect your Control Room to
the remote Git repository from Administration
> Settings > Remote Git repository
integration.

Usa impostazioni manuali Seleziona questa opzione per ripristinare i dati da
un qualsiasi altro archivio.
a. Enter the HTTPS repository path including

the username in the following format:
https://<username>@bitbucket.org/
companyname/product.git

b. Enter the branch name.
c. Enter your Git repository password or a

generated Git token.
d. Inserisci nuovamente la password o il token

Git per confermare.

Nota:  If you are using the same settings as the
existing Git configuration, you will encounter an
error. To use the same configuration, first remove
the remote Git repository integration setting in
Administration > Settings > Remote Git
repository integration before providing the
same in this manual settings option.

6. Opzionale: Select the Connect to Git via proxy check box.
a) Enter the proxy host name or IP address.
b) immetti il numero della porta.
c) Opzionale: Select the authentication check box and enter the user name and password.

7. Fai clic su Continua per procedere con il processo di ripristino.
Il sistema avvia il ripristino dei bots e dei file dipendenti da Git. Questo processo richiede un po' di
tempo.
After the restore process is completed successfully, you are automatically returned to the
Automation page. I bots e i file dipendenti vengono ripristinati nel nuovo database, mantenendo la
struttura originale dei file dipendenti.

Se il processo di ripristino Git non riesce dopo il ripristino di alcuni bots, si viene reindirizzati all'area di
lavoro pubblica con le seguenti opzioni. Scegli l'opzione richiesta per completare il processo di ripristino:
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Opzione Azione

Ripristina ripristino dei bot Questa opzione cancella tutti i bots ripristinati.

Nota:  Questa opzione eliminerà i bots pubblici
ripristinati dall'archivio Git.

Riavvia ripristino Il processo di ripristino Git riparte dal punto in
cui era terminato.

Mantieni solo i file ripristinati Questa opzione mantiene tutti i file ripristinati ed
esce dal processo di ripristino.

Statistiche di utilizzo
Automation Anywhere collects usage statistics from Automation 360 for product improvements.
Usage statistics provides information on where users might be facing issues with the product, the most
used or least used features, and so on. This information helps in product improvement which in turn helps
in improving the customer experience.
By default, the Usage statistics option is enabled in the Control Room and usage data is collected. The
data collected is stored in Automation 360 and the service provider cloud. The collected data is typically
generic information such as anonymized user details, customer name, and user navigation workflows such
as menus the users access and clicks.
An administrator can disable the Usage statistics option by changing the settings in the Control Room.

Nota:  The option can be disabled only for On-Premises deployments.

Disable usage statistics
An administrator can disable the Usage statistics option by changing the settings in the Control Room.
Ensure that you are logged in to the  as the administrator.
1. Navigate to Administration > Settings > General > Advanced settings.
2. Click the Edit icon. ( )
3. Select the Disabled option.
4. Fai clic su Salva modifiche.

Set up instances for Cloud-enabled deployments
Manage trust relationship between the cloud-deployed Automation 360 Cloud-enabled instance and the
On-Premises applications.
Ensure that you are logged in to the  as the administrator.
For Cloud-enabled deployment, the initial welcome email that you received from Automation Anywhere
contains:
• URL to the Automation Anywhere Cloud-enabled instance
• Provisioning token needed to establish trust connectivity with the Automation Anywhere Cloud Control

Room

Automation Anywhere deploys and configures an Automation Anywhere Automation 360 Cloud instance for
this Cloud-enabled deployment option. The customer then installs the On-Premises application within their
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infrastructure for storing and processing customer data. After this is complete, you install the On-Premises
application within your infrastructure for storing and processing customer data.
1. Log in to the On-Premises Control Room as the administrator.
2. Navigate to Administration > Settings > Cloud-enabled.
3. Provide the provisioning token to connect to the Control Room.
4. Fai clic su Salva modifiche.
5. Opzionale: Test the Cloud-enabled functionality.

Open a browser and enter the URL for the Cloud Control Room service instance. Click Enter to be
redirected to the On-Premises Control Room.

Generate registration key to install Bot Agent in bulk
The Control Room administrator can generate a registration key to install the Bot Agent on multiple devices
at a time in bulk.
Ensure you have set up the Microsoft Active Directory group policy to remotely install the Bot Agent on
multiple devices.
Use Microsoft Active Directory Group Policy to remotely install software

Generate and copy the key for use in an installation script or as part of the Active Directory group policy to
install the Bot Agent on multiple devices at a time.
Also, download the latest Bot Agent MSI installer file to your default downloads path to install the Bot
Agent in bulk.
1. Navigate to Administration > Settings.
2. Select the Bot agent bulk install option.
3. Generate a new registration key for installation.

Nota:  Before you generate a new key, keep in mind that the new key invalidates the previous key
and any entries or references to the previous key must be replaced with the new key value. Therefore,
we recommend that you generate a new key only if the previous key is compromised.

a) To launch the setting in edit mode, click the Edit option.
When you open this setting for the first time, the option Generate a new key is shown by
default and the phrase Key not set appears.

b) To create a new registration key, select the Generate a new key option.
c) To install the Bot Agent using an installation script or through a Active Directory group policy, click

Copy to clipboard.
d) Salva le impostazioni.

4. Replace the registration key:
a) To launch the setting in edit mode, click the Edit option.

The Keep current key option is displayed by default.
b) To generate a new registration key, select the Generate a new key option.
c) Select Continue on the Current registration key replacement message box.
d) To use the key, click Copy to clipboard.
e) Save the updates.
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5. To download the latest Bot Agent MSI installer file, click Download installer.
The Bot Agent installer MSI file is downloaded to your default Downloads folder.

Edit the Bot Agent MSI file to remotely install the Bot Agent on multiple devices.
Attività correlate
Bulk install Bot Agent on devices alla pagina 1053
Installing Bot Agent across multiple devices such as on-premises machines, virtual machines (VM), and
non-persistent virtual desktop infrastructure (VDI) is called Bulk install (or silent install). You must edit the
Bot Agent MSI file for bulk installation.

Edit the Bot Agent installer file
Edit the Bot Agent MSI installer file to add the registration key and Control Room URL to remotely install
the Bot Agent on multiple devices.
To perform the task, you must have a  administrator account with the required rights and permissions.
Ensure the Windows 10 Software Development Kit including Orca and Control Room are installed on
your device. È possibile installare Orca da C:\Program Files (x86)\Windows Kits\10\bin
\10.0.18362.0\x86\Orca-x86_en-us.msi.
Set up the Microsoft Active Directory group policy to remotely install the Bot Agent on multiple devices.
Use Microsoft Active Directory Group Policy to remotely install software

Edit the Bot Agent.msi file to enable the Control Room administrator to implement the auto-update Bot
Agent policy.
1. Utilizza il file AutomationAnywhereBotAgent.msi più recente, disponibile dalle seguenti posizioni:

• Scarica il file dalla Control Room (Amministratore >  Impostazioni > Installazione in blocco
dell'agente bot).
L'opzione di download è disponibile per le distribuzioni On-Premises e Cloud.

• Seleziona il file dall acartella <application filepath>\crui\asset. Ad esempio C:
\Program Files\Automation Anywhere\crui\asset

Questa opzione è disponibile solo per le distribuzioni On-Premises.

2. Edit the AutomationAnywhereBotAgent.msi file using Orca tool.
3. Fai clic sull'opzione Proprietà.
4. Change the value for AA_CRTOKEN and AA_CRURL.

The AA_CRTOKEN uses the registration key and the AA_CRURL uses the Control Room URL for which
the registration key is generated.

5. Salva le modifiche.

Configurazione dell'integrazione con SIEM
The Automation Anywhere Control Room supports security information and event management (SIEM)
tools ingesting logs from your tenant's Audit logs.
With SIEM integration, audit logs can be sent to analytic tools, such as Splunk, Qradar, Sumologic, and
ArcSight. Inviando le voci del log di audit agli strumenti SIEM, puoi integrare e sfruttare le funzioni
avanzate di ricerca e reporting delle soluzioni SIEM. Una volta configurati, i log di audit della Control Room
vengono inoltrati al server SIEM configurato.
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Configura un server SIEM passo-passo per consentire la ricezione dei messaggi di audit inviati da
Automation 360. Nell'esempio seguente il provider SIEM utilizzato è Sumo Logic. Utilizza la stessa
procedura per configurare qualsiasi altro server SIEM.

Impostazione di Sumo Logic
Setup the Sumo Logic as a SIEM tool to collect logs.
Per utilizzare Sumo Logic come endpoint di registrazione, devi creare un account Sumo Logic, aggiungere
una nuova fonte e salvare l'URL di origine HTTP.
Per aggiungere una nuova fonte nel sito web di Sumo Logic, procedi nel seguente modo:
1. Dopo aver creato l'account Sumo Logic, viene visualizzata l'Installazione guidata di Sumo Logic. Se già

disponi di un account, puoi accedere alla procedura guidata selezionando Configurazione guidata
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dalla sezione Gestisci nella parte superiore dell'applicazione Sumo Logic. In the Setup Wizard, click
Set Up Streaming Data

Viene visualizzata la finestra Seleziona tipo di dati.
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2. Fai clic su Tutte le altre fonti.

Viene visualizzata la finestra Imposta raccolta.
3. Fai clic su Fonte HTTP.

Viene visualizzata la finestra Configura fonte:Fonte HTTP.
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4. Inserisci un nome in Categoria fonte (ad esempio, Input http) e seleziona un fuso orario per i file di
log.

5. Click Continue to see a magic url such as the following:https://
endpoint1.collection.us2.sumologic.com/receiver/v1/http/
ZaVnA4dhaV0nFJAEMuwFDGEEZUnDedm7hYhkdUJSAE44bmKKp1mp4LsYDCr2MzTA0C21czkqjz9UVjC1mk4lw512KQ7Usz3OAmNwCMWO09eK9r7h2VZT7B==

6. Salva l'URL in un editor. Ti servirà per aggiungerete Sumo Logic come endpoint di registrazione SIEM.
Aggiunta di Sumo Logic come endpoint di registrazione SIEM alla pagina 2769

Aggiunta di Sumo Logic come endpoint di registrazione SIEM
To configure the server where audit logs will be sent, add the Sumo Logic as an SIEM logging endpoint.

Nota:
To perform the task, you must have a  administrator account with the required rights and permissions.
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1. Naviga su Amministrazione > Impostazioni > Configurazione integrazione di SIEM.

2. Click the Edit icon. ( )
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3. Seleziona Abilitato e incolla l'endpoint del server SIEM copiato da Aggiunta di Sumo Logic come
endpoint di registrazione SIEM alla pagina 2769.

Nota:  Consulta la documentazione del tuo provider SIEM per le informazioni relative alle intestazioni
HTTP e i requisiti degli attributi JSON (corpo della richiesta).

4. Seleziona il metodo HTTP POST, in quanto Sumo Logic accetta gli input come metodo POST.

Nota:  Il certificato dello strumento SIEM è facoltativo e dipende dal provider SIEM. Alcuni provider
SIEM richiedono l'inserimento di un certificato valido dello strumento SIEM.

© 2023 Automation Anywhere. All rights reserved.     2771



    Automation Anywhere - Gestisci

5. Specifica un nome per Attributo evento (ad esempio, audit). Tutti i messaggi di log saranno
registrati in questa categoria e fungeranno da chiave per individuare tutti i log degli eventi.

Nota:  L'attributo Timestamp è un campo facoltativo e dipende dal mapping del provider SIEM per
questo campo. Ad esempio, Splunk richiede il valore ora mappato in uno dei suoi campi timestamp.
La lunghezza massima consentita è di 256 caratteri. Sono ammessi tutti i caratteri speciali, tranne la
barra rovesciata (\) e le virgolette doppie ("). Questi caratteri devono essere preceduti da un carattere
di escape.

6. Fai clic sul segno + per inserire alcune coppie chiave-valore per il corpo (attributi statici) da
inviare con i log. Le coppie chiave-valore accettano anche caratteri speciali. Potrai configurare
massimo 50 attributi.

7. Fai clic sul segno + per inserire alcune coppie chiave-valore per l'intestazione da inviare con
tutti i log di dati degli eventi. I dati di intestazione sono specifici del provider SIEM. Ad esempio, Sumo
Logic supporta i nomi di intestazioni che iniziano con X (come X-Sumo-Campi). Potrai configurare
massimo 50 intestazioni.

Per ulteriori informazioni sui dati di intestazione, consulta la documentazione del provider SIEM
corrispondente.

Verifica dei dati in Sumo Logic
La ricezione dei log di audit viene verificata tramite l'interfaccia web di Sumo Logic. Un modo per farlo è
cercare gli eventi utilizzando il nome del raccoglitore e della fonte.

Procedi nel seguente modo per verificare i dati in Sumo Logic:
1. Genera un log di audit creando un evento. Ad esempio, crea un utente (Create a user alla pagina

2684).
2. Vai a Log di audit alla pagina 2654 per vedere la voce nei log.

In Sumo Logic, vedrai l'evento registrato nella fonte configurata durante l'impostazione di Sumo Logic.
Impostazione di Sumo Logic alla pagina 2766

3. Navigate to Manage Data > Collections
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4. On the Collection tab, click Open in Log Search icon next to the respective log source.

Vengono visualizzati gli eventi filtrati per raccoglitore e fonte. Viene visualizzato un evento di creazione
di un utente in formato JSON inviato a Sumo Logic tramite HTTPS.

Use AuthConfig App to enable OAuth2 services
As an Organization Administrator with access to CALM (Automation Anywhere app hosted on Salesforce),
you use the AuthConfig App to manage the relationship between a set of Automation 360 Control Room
instances and our OAuth2 (Open Authorization) services.
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Nota:  The availability of this feature is based on your region.

You use OpenID tokens (issued by Salesforce) to authenticate to the AuthConfig App.

Token overview

Automation Anywhere and the AuthConfig App support the following token types:
• Control Room registration token: The AuthConfig App generates this token which you enter in

the OAuth Settings panel of the Automation 360 Control Room. The Control Room registration token
establishes the identity of your Control Room to the AuthConfig App. After you register and enable the
token, the Control Room can consume access tokens to call APIs.

• Access token: A JSON web token generated from an authorization provider after authenticating with
an Identity Provider (IdP). Access tokens contain claims that provide information to a resource server.
API calls use access tokens to enable an authorized client to gain access to data on the resource server.

• Refresh token: Refresh tokens provide a method to get new access tokens without having to collect
and authenticate credentials every time an access token expires.

The AuthConfig App generates Control Room registration tokens to enable OAuth2 services. The following
diagram shows how a registration token flows between the AuthConfig App and the Automation 360
Control Room:

1. The Administrator uses the AuthConfig App to generate a registration token.
2. The registration token is stored in the database.
3. The Administrator enters the generated registration token into the OAuth Settings in the Automation

360 Control Room.
4. The registration token is stored in the database.
5. The registration token is then sent to the AuthConfig App where if the token matches the token stored

in the database, the Control Room is registered.

Vantaggi

You use the AuthConfig App to:
• Enable or disable OAuth2 services for an Automation 360 Control Room (On-Premises or Cloud).
• Configure an Identity Provider (IdP) configuration using a SAML authentication connection for your

organization to use with OAuth2 services.
• Generate registration tokens for each Control Room to securely enable OAuth2 services.
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For details about accessing automations in a web scenario with AARI Extensions and using a custom
widget through Google Chrome extensions, click here.

Prerequisiti

Before you use the AuthConfig App:
• Create your Automation Anywhere community (Apeople) credential: A-People home page (login required).
• From the Automation 360 Control Room:

• To enable an IdP authenticated user to use an access token to call a Control Room API, you must
also add the IdP authenticated user as a Control Room user.

• To use access tokens, you must register and enable Control Room instances with OAuth2 services.

After you complete the prerequisites, you can access the AuthConfig App.

Access the AuthConfig App
The AuthConfig App generates Control Room registration tokens to enable OAuth2 services.
To access the AuthConfig App:
1. Log in to the Automation 360 Control Room as the Administrator.
2. To obtain the AuthConfig App login URL, you can either:

• From the Control Room, navigate to: Administration > Settings > OAuth, and then click the
link provided in the Registration text area, or

• Copy and paste this URL (default URL) into a browser window: https://
oauthconfigapp.automationanywhere.digital

3. The AuthConfig App Log in dialog box displays:

Click Log in to log in with your existing Apeople credentials. You are re-directed to the A-People home
page (login required) page.
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4. From the A-People home page, enter your credentials (username and
password) and click Log in. You are re-directed to the AuthConfig App

page:

From AuthConfig App page, you can:
• Review existing On-Premises and Cloud Control Room instances to enable OAuth2 services
• Configure SAML
• Manage refresh tokens

To log out of the AuthConfig App:
1. Click your username profile at the bottom of the page to open the Log Out dialog box:

2. Click Log Out.

Review Control Rooms
If not already displayed on the AuthConfig App page, select Control Rooms on the left side of the page
to display a list of all your On-Premises and Cloud Control Rooms.
If new Control Room instances were added through CALM (Automation Anywhere App hosted on
Salesforce), click Sync cloud Control Rooms at the top of the page to update and display them in the
list.
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Nota:  If you delete a Cloud Control Room from the AuthConfig App (which still has a valid license in
Salesforce), then the Cloud Control Room will re-appear in the Control Room list after syncing.

From the Review Control Room page, you can:
• Generate a registration token for a Control Room
• Enable or disable OAuth2 services for a Control Room
• Add or delete an On-Premises Control Room

Generate a registration token for a Control Room

To generate a registration token for a Control Room:
1. Click the Control Room name or hover over the actions menu (three vertical ellipses) located to

the right of the Control Room name and click the Binoculars icon. The Control Room details page
displays.

2. To generate a registration token for the Control Room to enable
OAuth2 services, click Generate token at the top right of the

page:
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3. A confirmation message displays asking if you want to generate the token. The generated token is
required to register your Control Room tenant with OAuth2. Click Generate.

4. A dialog box displays the newly generated registration token. Click Copy token.

Nota:  You should store this token in a safe place for future use. You cannot retrieve this token after
you close the window.

5. Navigate to: Administration > Settings >

OAuth. In
the text area, paste the token you copied to register the Control Room with our OAuth2 services to
enable using OAuth2 access token.

6. Click Validateand review the data to ensure that it matches the Name and Host URL you were
expecting.

7. Fai clic su Salva modifiche.

This registers the AuthConfig App with the selected Control Room.

Enable or disable OAuth2 services for a Control Room

To enable or disable OAuth2 services for a Control Room:
1. Click the Control Room name or hover over the actions menu (three vertical ellipses) located to

the right of the Control Room name and click the Binoculars icon. The Control Room details page
displays.
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2. By default, the OAuth2 services for a Control Room are disabled. To enable
OAuth2 service, click the Enable OAuth toggle at the top right of the

page:
The OAuth status changes to Enabled.

3. Click < Back to return to the Control Room list.

Add or delete an On-Premises Control Room

Nota:  You cannot add a Cloud Control Room because it is consumed automatically by the AuthConfig
App.

To add an On-Premises Control Room:
1. Click the Add Control Room icon at the top right of the page:
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2. The Add an On-Premises Control Room dialog box displays:

a. Enter a unique Name and Host URL (for example: https://
digital.automationanywhere.com/nextbank) for the new On-Premises Control Room.
The host URL you enter must match the URL you provided to your external OAuth client (for
example: Pixiebrix).

b. Click Submit when finished.

To delete an On-Premises Control Room:
1. Hover over the actions menu (three vertical ellipses) located to the right of the Control Room name

and click the Delete icon:

2. A confirmation message displays asking if you want to permanently delete the Control Room. Click
Yes, delete to remove the registered Control Room from the AuthConfig App.

Configure SAML connection details
You configure SAML to authenticate to your Identity Provider (IdP) to obtain OAuth access tokens.
To configure SAML connection details:
1. From AuthConfig App page, select SAML Configuration on the left side of the page.
2. Click New SAML configuration at the top of the page.
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3. The New SAML configuration dialog box displays:

a. Enter the connection name and sign-in URL from your external Auth Provider.
b. Enter your Identity Provider's (IdP) public key or click Browse to search for it. The public key

validates the IdP's signed response.
c. Fai clic su Crea.

The connection name configuration details

display:
The ACS (Assertion Creation Service) URL directs your IdP where to send its SAML response after
authenticating a user, and the Entity ID is the unique identifier of the IdP.
To delete the SAML configuration, click Delete at the top right of the page. A confirmation message
displays asking if you want to delete the SAML configuration.

Nota:  If you delete the SAML configuration, Control Room users will not be able to obtain new access
tokens using our OAuth2 service.

Click Delete to continue.
Manage refresh tokens
One SAML connection can have multiple tokens.
To manage the refresh tokens:
1. From AuthConfig App page, select Refresh Token on the left

side of the page. The Refresh Token Management page displays:

2. You can enter SAML connection name or subject search parameters in the Search box.
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3. To revoke a refresh token, hover over the actions menu (three vertical ellipses) located to the right of
the token name and click the X (Revoke) icon.

4. A confirmation message displays asking if you want to revoke the token.

Nota:  By revoking the refresh token, the associated application will not be able to obtain a new
access token using the refresh token.

Click Revoke.

Analisi del codice
L'analisi del codice consente di valutare un programma senza eseguirlo. In Automation 360, the code
analysis feature analyzes the code and displays a list of violations based on a set rules. Puoi rivedere e
correggere eventuali errori di codifica o stilistici per l'automazione.
L'analisi del codice consente di formare determinate strutture di codice con le quali puoi implementare le
migliori pratiche di codifica e rendere il codice facile da manutenere, affidabile, efficiente e sicuro.
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Vantaggi

L'analisi del codice offre i vantaggi seguenti:
• Implementare le migliori pratiche di codifica rispettando determinate convenzioni di codifica.
• Autorizzare il Citizen Developer a introdurre nuove automazioni.
• Assicurare una maggiore accessibilità delle automazioni complesse.
• Migliorare la leggibilità e la qualità del codice.
• Controllare la struttura del codice di automazione.
• Improve productivity of the developer and the platform as good coding practise improves the

automation quality over time.

Analisi del codice in base ai ruoli degli utenti

Lead RPA Developer (Administrator) Configura i criteri di analisi del codice che
definiscono le migliori pratiche di codifica
nell'organizzazione. Monitora e segnala lo stato
della qualità del codice in base all'aderenza a questi
criteri. L'analisi del codice consente di applicare
determinate pratiche e principi di codifica che, a
loro volta, contribuiscono a:
• Facilitare lo sviluppo dell'automazione da parte

di un pool più ampio di personale aziendale, ad
esempio un Citizen Developer che potrebbe non
avere forti competenze di sviluppo software.

• Migliorare la manutenzione delle automazioni
riducendo la complessità del codice e
migliorandone la leggibilità.

• Migliorare l'affidabilità delle automazioni
riducendo gli errori.

• Migliorare la sicurezza e la conformità delle
automazioni applicando pratiche di codifica
sicure.

• Ridurre i tempi di produzione e i costi di
automazione.
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Citizen Developer o sviluppatore RPA L'analisi del codice fornisce indicazioni per lo
sviluppo di automazioni che soddisfino i requisiti
organizzativi relativi a:
• Riduzione degli errori
• Leggibilità e manutenzione del codice
• Sicurezza del codice
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See the following video for an overview of how code analysis is configured:

Autorizzazioni

Per impostare un criterio di analisi del codice sono necessarie le autorizzazioni seguenti.
• Visualizza criteri: consente di visualizzare il criterio di analisi del codice che definisce le modalità di

creazione delle automazioni.
• Gestisci criteri: consente di visualizzare e modificare il criterio di analisi del codice che definisce le

modalità di creazione delle automazioni.
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Componenti

• Editor di criteri: contiene un criterio globale per tutti gli utenti Control Room.
• Regole: come fondamento dell'analisi del codice, le regole consentono di valutare il codice bot. Le

regole possono essere semplici o complesse, a seconda della valutazione che viene eseguita. Le regole
includono pratiche di codifica che possono essere verificate. Si applicano a packages e actions nel
codice di automazione. Una regola è costituita da un codice univoco RULE_CODE e da una descrizione
che indica la natura della valutazione da eseguire sul codice.

Code analysis rules
Rules are the foundation of code analysis. They are used to evaluate the bot logic. Rules can be simple
or complex depending on the evaluation performed. Le regole includono pratiche di codifica che possono
essere verificate. They apply to packages and actions in the automation code.
A rule consists of a unique RULE_CODE and a description which indicates the nature of the evaluation to
be done on the code. You can use the severity levels (low or high) to emphasize the criticality of the rule.
La tabella seguente elenca le regole che possono essere utilizzate con l'analisi del codice e la loro
descrizione:

Codice della regola Gruppo Titolo Descrizione della regola

ACT-GEN-001 Actions, general Action Maximum The number of actions in the
bot cannot exceed the specified
maximum

ACT-GEN-002 Actions, general Try-Catch Coverage All the non-comment actions
within the bot logic must be within
a Try/Catch block.

ACT-GEN-003 Actions, general Infinite Loop
Detection

Mandates the check for infinite
loops in the bot logic

VAR-NMG-001 Variables, naming Variable Name
Pattern

Variable names must match the
specified naming pattern

VAR-NMG-002 Variables, naming Variable Name Length Variable names must be within the
specified minimum and maximum
character length

VAR-USG-001 Variables, usage No Unused Variables All the variables must be used
within the bot

ACT-COM-001 Actions, comments Mandatory Header
Comment

The first action in the bot must be
a Comment action

ACT-COM-002 Actions, comments Comment Coverage The number of Comment actions
must be equal to or greater than
the specified percentage of total
command actions

VAL-HCV-002 Values, hard coded
values

No Hard Coded Delay The delay time in the Delay
action must be set using a variable

VAL-HCV-003 Values, hard coded
values

No Hard Coded File
Path

The file or folder path must be set
using a variable
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Codice della regola Gruppo Titolo Descrizione della regola

VAL-HCV-004 Values, hard coded
values

No Hard Coded Email
Address

The command action field must
not contain a hard-coded email
address

ACT-ERR-001 Actions, error
handling

No Empty Catch The catch block cannot be empty

ACT-ERR-002 Actions, error
handling

Mandatory Catch
Logging

The catch block must contain a
Log to File action

ACT-ERR-003 Actions, error
handling

Mandatory Catch
Screen Capture

The catch block must contain a
Screen capture action

ACT-ERR-004 Actions, error
handling

Mandatory Catch Line
Reference

The catch block error must contain
the reference line number

ACT-LOG-001 Actions, logs Log to file coverage The bot logic must contain the
specified ratio of Log to file
actions

Reviewing code analysis results
As a Bot Creator (RPA developer) or Citizen Developer, you can use code analysis to check and fix any
coding errors in your bots. You can develop automation based on configured code analysis policies and
predefined rules.
With code analysis, you can improve the reliability of your bots by implementing coding best practices
such as variable naming conventions, comment coverage, and error handling. Building bots conforming
to the predefined guidelines or rules helps you to identify possible errors during bot development. This
reduces bot failures in the production environment. You can run code analysis in both your private and
public workspaces and view the results.
With code analysis (available from the Bot editor), you get the following benefits:
• Run code analysis as required.
• Get tooltip guidance for compliance with rules
• Integration with Assistant for accounting and guidance.

Code analysis results

To view the results of code analysis, go to the Automation page, and check the Code Analysis results.
This column shows a summary status of the code analysis results for each automation file. The following
details of each status are available:
• N/A: Code analysis does not apply to the object because the object is a folder or is not a bot file.
• Not Scanned: Code analysis has not been run on the bot.
• High severity: The bot has at least one high severity violation.
• Low severity: The bot has at least one low severity violation, but no high severity violations.
• No violations: There are no code analysis violations in the bot.

The following image shows an example result from code analysis:
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Nota:  The status of the bots in the code analysis results column is set to not scanned for the following
scenarios:
• The bot is edited in the private workspace.
• Code analysis is disabled by the administrator or there is a change in any of the rule configuration.

Reviewing results in Bot editor

When you create a bot or modify an existing bot and then save the bot in the Bot editor, code analysis is
initiated in the background, and the results are displayed in the Assistant. The code analysis header shows
the total count of violations in the bot. You can expand the code analysis option, select a specific object
and view the following attributes:
• Applicable object: Displays the bot, variable, action, and action attribute.
• Rule code: Unique RULE_CODE ID.
• Severity: High or low.
• Rule text: Description to indicate the nature of evaluation to be performed on the code.

The following image shows an example of code analysis displayed in the Assistant:
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The code analysis results are displayed in the following order:

Attributo Rules violated

Bot • Mandatory header comment
• Comment coverage
• Action maximum

Variabile • Variable name pattern
• Variable name length
• Tutte le variabili inutilizzate

Azione • No hard-coded delay
• No hard-coded file path
• No hard-coded email address
• No empty catch
• Mandatory catch logging
• Mandatory catch screen capture

The code analysis header displays the count of objects with a violation error within the bot. Each object
can have either low or high severity. The violation is displayed with the attribute followed by the line
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number and the severity. All the high severity errors are displayed first. Navigate to the corresponding line
in the bot that has the violation, rectify the violation, and save the bot.
You must save the bot to see the latest code analysis results in the Assistant.

System-created variables

Variables created by the system such as input or output variables, package-suggested variables, or auto-
generated variables (window variables) use the default variable naming case convention from code analysis
or Pascal case if no format is defined in code analysis rule.

Log di audit

When code analysis is initiated either by saving a bot or running code analysis in the Bot editor, the
information is captured in the audit log. The following details are captured:
• Nome Bot
• User information
• The method through which code analysis is initiated (save option or run code analysis option)
• Time taken for the code analysis to run including details such as the number of code lines if captured

by code analysis process
• Total number of violations
• Details of the violations

Code analysis reports
You can access the code analysis report from the Automation page after running code analysis. Il
rapporto è sotto forma di file CSV scaricabile.
You must have View content permission to download the code analysis results in CSV format.

The report contains the results of the code analysis policy. It details the violation, the location of the
violation, and the bot file location. The code analysis report consists of the following:
• Codice della regola
• Descrizione del messaggio di errore della regola (con la posizione del file bot appropriata)
• Posizione del bot
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The following image shows an example code analysis

report:

Configure code analysis policy
As an administrator or a user with view and manage policy permissions, you can configure code analysis
policies to define coding best practices to improve reliability of automations by reducing errors.
Ensure that you have the following permissions:
• Visualizza i criteri
• Gestisci criteri

1. Accedi alla Control Room come amministratore.
2. Accedi a Amministrazione > Criteri.
3. Fai clic su Abilitato nella sezione Stato.

Per impostazione predefinita, questa funzione non è abilitata.
4. Imposta una o più regole nella sezione Regole.

Nota:  Devi impostare almeno una regola per abilitare la funzione di analisi del codice.

5. Select the Severity as either Low or High to highlight the criticality of the rule.
Una volta abilitato il criterio, questo viene applicato a tutti gli utenti a livello globale.
Whenever the policy is updated, a prompt is displayed indicating that the policy is updated, and the
code analysis results page contains details about the bots that have violations.
The following video displays how to configure the code analysis policy:
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Run code analysis
As a Bot Creator (RPA developer) or Citizen Developer, you can run code analysis to evaluate your bots for
any coding errors. You can develop automations based on the code analysis policies and predefined rules.
You must have View content permission to download the code analysis results in CSV format.
• You can run code analysis only on bots that are error-free. If your bots contain errors, the Run Code

Analysis option is not enabled. Resolve the errors in your bot to see the Run Code Analysis option.
• Code analysis automatically runs on all the bots with the Not Scanned status in the public workspace,

thereby providing visibility on the coding best practices for all the bots in the public repository. Code
analysis runs every five minutes and scans 1000 bot files in five minutes.

• Code analysis is not invoked on API bot files.

• Run code analysis in the private workspace:
a) On the Automation page, select the bot, click the actions menu (vertical ellipsis), and click Run

Code Analysis.
A message is displayed indicating that code analysis is successfully completed, along with a file link
with the result of the code analysis.

b) Click the file link to analyze the result of code analysis.
A CSV file with the result of code analysis is displayed.

c) Fai clic su Chiudi.

• Run code analysis in the public workspace: Run code analysis by choosing one of the following
options:
Opzione Fasi

Run Code Analysis 1. On the Automation page, select the bot, click the
actions menu (vertical ellipsis), and click Run Code
Analysis.

2. Select the version of the bot for which to run code
analysis:
a. Versione più recente
b. Product label

3. Click Continue.
A message is displayed indicating that code analysis is
successfully completed, along with a file link with the
result of code analysis.

4. Click the file link to analyze the result of code analysis.
A CSV file with the result of code analysis is displayed.

5. Fai clic su Chiudi.
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Opzione Fasi

View history Task Bot 1. On the Automation page, select the bot, click
the actions menu (vertical ellipsis), and click View
history Task Bot.
All the versions of the selected bot are displayed on
top showing the latest version.

2. Select a version of the bot, click the actions menu
(vertical ellipsis), and click Run Code Analysis.
A message is displayed indicating that code analysis is
successfully displayed, along with a file link with the
result of code analysis.

3. Click the file link to analyze the result of code analysis.
A CSV file with the result of code analysis is displayed.

4. Fai clic su Chiudi.

The following video shows the two ways of running code analysis in the public workspace:

Manage licenses
La Automation Anywhere Control Room fornisce un meccanismo automatizzato per tenere traccia
dell'utilizzo di software concesso in licenza su più istanze della Control Room e condividere queste
autorizzazioni in tempo reale.

Tutte le licenze

Gli amministratori della Automation Anywhere Control Room possono visualizzare, condividere e gestire le
autorizzazioni per le licenze utente su più istanze della Control Room da un'unica Control Room. Accedi ad
Amministrazione > Licenza per visualizzare un riepilogo delle licenze dei prodotti seguito dalla tabella
Riepilogo licenze.

Nota:
To perform the task, you must have a  administrator account with the required rights and permissions.

Servizi di licenza su cloud

Per modificare e/o aggiornare le impostazioni delle licenze tramite il servizio Licenza su cloud, fai clic su
Modifica impostazioni licenze e fornisci le informazioni necessarie nella pagina di Modifica.
For more information on this subject, see these resources:
• Licenze e servizi cloud alla pagina 1008
• Gestione delle licenze cloud e di file alla pagina 1010
• View and edit Cloud Control Room instances alla pagina 1018
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License summaries

La tabella Riepilogo licenze illustra in dettaglio lo stato di tutte le licenze distribuite o disponibili per la
distribuzione su qualsiasi Control Room attiva. I dettagli visualizzati sono relativi al punto di vista della
Control Room corrente. Questo tipo di accesso in tempo reale alle informazioni sulle licenze da più
distribuzioni in rete consente un'integrazione perfetta per l'attribuzione delle risorse RPA necessarie in base
alle esigenze.

Aggiornamento delle licenze da un server

Per aggiungere licenze per gli utenti, seleziona il metodo di accesso richiesto facendo clic su Installa
licenza dal server o Installa licenza da file.

Installazione di licenze aggiuntive
Carica le nuove licenze in Automation Anywhere Control Room da distribuire agli utenti come richiesto.
Ensure that you are logged in to the  as the administrator.
Designa l'origine della licenza (server o percorso file) da caricare in Control Room. Puoi anche utilizzare i
servizi di Licenza su cloud da questa pagina, se abilitati. Consulta Licenze e servizi cloud alla pagina 1008
per ulteriori informazioni.
1. Navigate to Administration > Licenses.
2. Seleziona Installa licenza dal server o Installa licenza da file o Modifica impostazioni

licenze.
Scegli l'origine dell'installazione.
Opzione Azione

Installa licenza dal server a. Fornisci il GUID univoco della Control Room.
b. Fai clic su Installa licenza dal server.

Installa licenza da file a. Individua e seleziona la licenza.
b. Fai clic su Installa licenza da file.

Modifica impostazioni licenze a. Inserisci il GUID univoco nel campo fornito.

3. Fai clic su Salva modifiche.

Riferimenti correlati
Utenti alla pagina 2683
As an administrator, you can create, view, edit, delete, and enable or disable a user. Creating users steps
vary depending on whether the user is a non-Active Directory, Active Directory, or single sign-on (SSO)
user from an IdP server.
System roles alla pagina 2709
System roles are preconfigured with the permissions necessary to perform the tasks within the scope of
that role. They cannot be modified or deleted. Administrators assign the roles to users to enable them to
access features and perform operations in the Control Room.
Impostazioni alla pagina 2721
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Utilizza la scheda Impostazioni per configurare la connessione a Credential Vault, abilitare le notifiche e-
mail, integrare Control Room con un archivio Git, abilitare la modalità di registrazione sicura e configurare
l'autenticazione utente.

Stop and start Control Room services on Linux
Review the instructions and service names to stop and restart Automation Anywhere Control Room
services on Linux.
Log in to your Automation Anywhere Control Room server.
1. If you just finished installing A2019, use the following command to display the status of all Control

Room services:
sudo systemctl status control*

Browse through the output. If any of the services are not actively running, you can manually start the
service with the following command (see the next step for specific service names):
sudo systemctl start <servicename>

Nota:  If more than one service is not running, you can use the script in the next step to start all the
services.

For other Linux installation issues, contact Automation Anywhere support: Open a support case (A-
People login required).

2. Opzionale: Create a script from the following code, such as startallaae.sh, to start all the Control
Room services.
This sample script lists the Control Room services that need to be restarted. You can restart the
services in any sequence.
The sleep commands allow each service to complete startup before the next service is started.

Nota:  controlroomdiscoverybot.service is only installed by default starting in Automation 360 version
16.

echo Starting elastisearch
sudo systemctl start controlroomelasticsearch.service
sleep 30
echo Starting botcompiler
sudo systemctl start controlroombotcompiler.service
sleep 30
echo Starting control room caching
sudo systemctl start controlroomcaching.service
sleep 30
echo Starting backend service
sudo systemctl start controlroombackend.service
sleep 30
echo Starting reverse proxy
sudo systemctl start controlroomreverseproxy.service
sleep 30
echo Starting messaging
sudo systemctl start controlroommessaging.service
sleep 30
echo Starting iq bot
sudo systemctl start controlroomiqbot.service
sleep 30
echo Starting discovery bot
sudo systemctl start controlroomdiscoverybot.service
sleep 30
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echo Starting aari
sudo systemctl start controlroomaari.service
sleep 30
echo Starting storage
sudo systemctl start controlroomstorage.service
sleep 30
echo Starting ml services
sudo systemctl start controlroomdiscoverybotml.service
sleep 30

Assign execute permission to the script and run it: sudo ./startallaae.sh
3. To stop a single service, use the following command: sudo systemctl stop <servicename>.

Facoltativo: To stop all services for maintenance or other requirements, create a script, such as
stopallaae.sh, to stop the Control Room services.

sudo systemctl stop controlroommessaging.service
sudo systemctl stop controlroomreverseproxy.service
sudo systemctl stop controlroombackend.service
sudo systemctl stop controlroomcaching.service
sudo systemctl stop controlroombotcompiler.service
sudo systemctl stop controlroomelasticsearch.service
sudo systemctl stop controlroomiqbot.service
sudo systemctl stop controlroomdiscoverybot.service

sudo systemctl stop controlroomaari.service
sudo systemctl stop controlroomstorage.service
sudo systemctl stop controlroomdiscoverybotml.service

Assign execute permissions to the script and run it: sudo ./stopallaae.sh

Control Room log files
Various types of information about the Control Room are captured in different log files. You can analyze
these log files when the Control Room or a bot encounters an error and identify the root cause for that
error.

Panoramica

The log files capture information about the errors encountered by various components of the Control Room
such as the Bot Store, devices, and license. You can use the information in the log files to identify the root
cause of an error and resolve that error.

Log file locations

The Control Room log files are available at C:\ProgramData\AutomationAnywhere\Logs on the
machine on which you have installed the Control Room. The log files are named WebCR_<COMPONENT-
NAME>, for example, WebCR_BotStore, WebCR_Devices, and WebCR_License.
You can refer the following log files for the Control Room.

WebCR.log Contains log entries related to the initialization of
the Control Room and messages, if any.

WebCR_UserManagement.log Contains log entries related to the user
management module.
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WebCR_Ignite.log Contains log entries related to the Apache Ignite or
caching system.

WebCR_ServerRepository.log Contains log entries of the server repository related
functions.

WebCR_CredentialVault.log Contains log entries of Credential Vault related
function calls.

WebCR_Hibernate.log Contains log entries related to the Hibernate
system, ORM mapping and Query system, ActiveMQ
messaging subsystem, and so on.

On the Bot Runner machine (on which the Bot Agent is installed), the log files are available at C:
\ProgramData\AutomationAnywhere\BotRunner\Logs. You can refer the following log files for the
Bot Runner machine.

NodeManager.log Contains log entry details of the interaction with the
Bot Agent and the log entry of every message sent
to the Bot Agent.

BotLauncher.log Contains log entry details of the bots that are
deployed on this machine.

TriggerListener.log Contains log entry details of any triggering activities
that occur in bots with triggers.

The corresponding configuration XML files are available at C:\Program Files\Automation
 Anywhere\Bot Agent\config.

Gestione del carico di lavoro
Il modulo di gestione del carico di lavoro consente agli utenti di caricare file in formato Microsoft Excel e
CSV nella Control Room in modo che questa possa inserire i record dai file nelle distribuzioni dei bot.
Questi record contengono informazioni altamente sensibili come PII, PCI, PHI e altro ancora. I dati in
questione sono ben protetti dalla chiave di crittografia e conservati nella condivisione file e nel database.
Dividere le automazioni in Work Items piccoli e logici dalla pagina Carico di lavoro. Process the Work
Items simultaneously to ensure that your automation goals are achieved with optimum resource utilization.

Prerequisiti

Per gestire l'automazione del carico di lavoro, assicurati che ti sia stata allocata una combinazione di alcuni
o tutti i seguenti ruoli e autorizzazioni:

Tipo di funzionalità Privilegi

Ruoli utente • AAE_Queue_Admin
• AAE_Pool_Admin

Autorizzazioni per le attività • Visualizza la mia Attività in corso
• Visualizza i miei bot pianificati
• Pianifica i miei bot per l’esecuzione
• Visualizza e gestisci tutta l'attività

programmata dalle mie cartelle
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Tipo di funzionalità Privilegi

Autorizzazioni per i dispositivi • Visualizza e gestisci Bot Creator, Bot Runner
e i miei pool di dispositivi

• Crea pool di dispositivi
• Amministra tutti i pool di dispositivi

Autorizzazione per i bot • Visualizza i miei bots
• Esegui i miei bots

Autorizzazioni per il carico di lavoro • Visualizza e gestisci le mie code
• Crea code
• Gestisci tutte le code

Database

Le automazioni del carico di lavoro sono supportate sui seguenti database:
• SQL
• PostgreSQL
• Oracle

Altre risorse

Workflow map: Click the following schematic image to view this workload management workflow in an

interactive visual format:
1. Workload management process

Guarda il seguente video su come utilizzare la funzionalità Workload nella Control Room :
Attività correlate
Attach work item template to TaskBot alla pagina 2009
Attach a work item template to a TaskBot to use the TaskBot in workload automation.
Use Work Item variables alla pagina 2038
You can use the Work Item variables to pass the Work Item attributes or values to the TaskBot from the
Control Room when you run the bot with the option Run bot with queue.
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Riferimenti correlati
Workload package alla pagina 1937
The Workload package enables you to insert work items in a queue for workload automation. It also
enables data chaining between multiple queues. You can orchestrate multiple bots, and enable optimal
device utilization through the queueing mechanism of workload management.

Creazione di code di carichi di lavoro
A queue is one of the main building blocks of Workload Management. A queue holds data known as
Work Items for further processing. The system distributes these Work Items to individual unattended Bot
Runners in a device pool for processing.
Per l'automazione del carico di lavoro, crea e allega un modello di elemento di lavoro a un bot, crea pool
di dispositivi, aggiungi Bot Runners al pool, crea code, aggiungi partecipanti, consumatori o proprietari di
code, definisci la struttura degli elementi di lavoro, inserisci elementi di lavoro e infine esegui l'automazione
con la coda.

Nota:  In a multi-user environment, if there are two queues A and B, and multiple work items are in
queue A, the device will process work items in queue A first, and then move to queue B. To process both
the queues in parallel in a multi-user environment, you must perform one of the following actions:
• Add another device to the existing device pool.
• Create another device pool on the same device.

Per informazioni dettagliate sulle attività che puoi eseguire come partecipante, consumatore o proprietario
di una coda, consulta la tabella seguente.

Proprietari Partecipanti Consumatori

Possono
• Visualizzare la coda
• Modificare la coda
• Aggiungere altri proprietari,

partecipanti o consumatori
alla coda

• Aggiungere elementi di
lavoro alla coda

Possono
• Visualizzare la coda
• Aggiungere elementi di

lavoro alla coda

Possono
• Visualizzare la coda
• Esegui bot con la coda…

Non possono: Esegui bot con
la coda…

Non possono: Esegui bot con
la coda…

Non possono: Aggiungere
elementi di lavoro alla coda

Partecipanti e proprietari coda: i proprietari delle code possono modificare una coda (cambiarne il
nome e la descrizione, aggiungere o rimuovere proprietari, partecipanti o consumatori), contrariamente ai
partecipanti.
You can create a workload queue in one of the following modes:
• Express mode
• Standard mode
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Modalità Express

To create queues in express mode with default parameters for workload automation in the Control Room.
For more information, see Create express queues using default workload parameters.

Standard mode

The following diagram describes the flow in which you can create a workload queue in standard mode.

To create a workload queue in standard mode,
1. Crea code alla pagina 2801

Create queues that hold specific sets of data your bot is expecting for automation. To create queues,
an Control Room administrator assigns the AAE_Queue Admin role with View and manage
my queues, Create queues, Administer all queues, and View my in progress activity
permissions.

2. Aggiungi proprietari coda alla pagina 2802
Add queue owners who can create, edit, and view queues.

3. Add participants to queue alla pagina 2802
Add queue participants from different roles defined in the Control Room. This is an optional step.

4. Add consumers of queues alla pagina 2803
Add queue consumers from different roles defined in the Control Room. This is an optional step.

5. Define Work Item structure alla pagina 2803
Define the Work Item structure for processing in a queue. This enables you to manually upload the
Work Items from the system in the absence of ready data in a file.

6. Insert Work Items alla pagina 2805
Add Work Items from an Excel or CSV file to the queue after you define the structure.

Attività correlate
Esegui bot con coda alla pagina 2807
Puoi elaborare collettivamente tutti gli elementi di lavoro di una coda in tutti i Bot Runners presenti in uno
o più pool di dispositivi.
Attach work item template to TaskBot alla pagina 2009
Attach a work item template to a TaskBot to use the TaskBot in workload automation.
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Creazione di code Express
Creare code con parametri predefiniti per l'automazione del carico di lavoro utilizzando l'opzione code
Express in Control Room.
Ensure that you are logged in to the  as the administrator.
È necessario disporre dell'autorizzazione Crea code per creare code utilizzando la modalità Express.
Quando crei una coda con parametri predefiniti, tieni presente quanto segue:
• All .CSV file columns will be available in a workload bot.
• The first 10 columns of the .CSV file will be displayed in the queue.
• Tutti i Tipo di dati saranno testo.
• L'ordinamento della coda non sarà disponibile.

1. Navigate to Manage > Queues.
2. Per creare code con i parametri predefiniti del carico di lavoro, fai clic su Crea coda Express.
3. Inserisci il nome della coda.

Per impostazione predefinita, il nome della coda è uguale al nome del modello dell'elemento di lavoro.
4. Opzionale: Immetti la descrizione della coda.
5. Per selezionare un file di dati in formato .csv, fai clic su Sfoglia.
6. Fai clic su Crea.

La coda viene salvata ed è disponibile per l'automazione del carico di lavoro nell'elenco Code.
È ora possibile visualizzare i dettagli della coda, modificare una coda ed eseguire un bot con coda.

Attività correlate
View queue details alla pagina 2812
Use the View queues details page to view the details of a particular queue.
Modifica code alla pagina 2813
Puoi modificare una coda utilizzando due metodi: dall'elenco Code o dalla pagina Visualizza coda.
Esegui bot con coda alla pagina 2807
Puoi elaborare collettivamente tutti gli elementi di lavoro di una coda in tutti i Bot Runners presenti in uno
o più pool di dispositivi.

Crea code
Create queues that hold specific sets of data your bot is expecting for automation. To create queues, an
Control Room administrator assigns the AAE_Queue Admin role with View and manage my queues,
Create queues, Administer all queues, and View my in progress activity permissions.
Ensure that you are logged in to the  as the administrator.
A queue is processed until all work items are completed. When new work items are added to the queue,
the Reactivation Threshold value specifies the minimum number of new work items required to resume
queue processing. Work items are those items with a Ready to Run status.
Create a queue by providing details such as the queue name, queue owners, participants, consumers,
work item structure, and auto-retry for failed work items.

Nota:  You can choose to Create draft of queue and add the remaining information later.

1. Navigate to Manage > Queues.
2. Click Create queue.
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3. Inserisci il Nome.
4. Opzionale: Immetti una descrizione.
5. Set the Reactivation Threshold to resume queue processing.

Default threshold is 1 (one).
6. Opzionale: Select the average Time required for a person to complete one work item:

• seconds
• minutes
• hours
• days

7. To process the failed work items, specify the Max auto retry attempt.
The failed work items are processed for the specified number of times after all the work items in a
queue are processed.
The default value of Max auto retry attempt is 0 which means the auto retry is not attempted by
default. The maximum Max auto retry attempt value is 10.

Nota:  The failed work items are processed at the end of the staging queue for auto retry.

Based on the specified Max auto retry attempt number, the Queues page shows the remaining
auto-retry attempts in the Retries left column.

8. Fai clic su Avanti.

Aggiungi proprietari coda alla pagina 2802
Attività correlate
Modifica code alla pagina 2813
Puoi modificare una coda utilizzando due metodi: dall'elenco Code o dalla pagina Visualizza coda.
Delete queues alla pagina 2817
Delete a selected queue, multiple selected queues, or all queues of work items.

Aggiungi proprietari coda
Add queue owners who can create, edit, and view queues.
Ensure that you are logged in to the  as the administrator.
Queue owners are allowed to edit the queue and add new work items to the queue.
The queue creator is the default queue owner and is able to add other Control Room users as queue
owners, if required.
1. Select user(s) from the Available Users list from the Owners tab.
2. Click the right arrow (→) to add your selection.
3. Fai clic su Avanti.

Add queue participants

Add participants to queue
Add queue participants from different roles defined in the Control Room. This is an optional step.
Ensure that you are logged in to the  as the administrator.
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Participant roles can add new work items and view the queue. However, they are not allowed to edit other
queue properties.
1. Select role(s) from the Available Roles list from the Participants tab.
2. Click the right arrow (→) to add your selection.
3. Fai clic su Avanti.

Add consumers of queues alla pagina 2803

Add consumers of queues
Add queue consumers from different roles defined in the Control Room. This is an optional step.
Ensure that you are logged in to the  as the administrator.
There are certain mandatory checks that are to be done for unattended bots to be deployed from Control
Room to a device:
• The device where the bot is to be deployed should be set as a default device to only the specific bot

runner account.
• Ensure that all necessary privileges have been granted to the Bot Runner.
• Ensure that nobody is signed into the device at the time of bot deployment with the Run As permission

from a different device.
• Ensure that the console is currently inactive on default device.

Queue consumers can view the queue and all the work items in the queue. In addition, they can use this
queue for running bots on Unattended Bot Runners.
1. Select role(s) from the Available Roles list from the Consumers tab.
2. Click the right arrow (→) to add your selection.
3. Fai clic su Avanti.

Define Work Item structure alla pagina 2803

Define Work Item structure
Define the Work Item structure for processing in a queue. This enables you to manually upload the Work
Items from the system in the absence of ready data in a file.
Define a Work Item structure using any one of the following methods:
1. Using an Excel/CSV file.
2. Using an existing work item template.
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3. Manualmente

Nota:  The work flow to process Work Items differs for a queue based on the method that you choose
in the Define Work Item Structure tab.

1. Select a method to add header columns for Work Item processing:
• Use an Excel/CSV file: Add the header columns from an existing Excel or CSV file. You can point

to the Excel spreadsheet or CSV file you are using in one or more TaskBots you will run in this queue.

a. Enter a unique name for the Work Item structure in the Work item template field.
For example, if the queue contains employee information, you can specify the Work item
template as Employee Data.

b. Select a column for inclusion in the Work Item structure from the list of column names. The
columns are defined based on the header rows of the selected Excel or CSV file. A maximum
of ten (10) columns are allowed for selection and viewing in the Control Room.
For example, you can select column headers Employee Name, Employee ID, and Designation.
You can then select the Data Type - Text, Number, or Date for that column. You can also
choose to view these columns being processed in the Activity page.

Nota:
• The system allows you to filter/sort Work Items on the columns for viewing the Work Item

data in the Control Room.
Actions allowed on view queue page alla pagina 2818

• When you upload work items from an xls or xlsx file with data type as text, the Excel file
column populated with a date in any format (for example, 8/6/2019) is converted to its
corresponding workload management date format (for example, Sat Jun 08 00:00:00) in
the Control RoomWork Item. However, the same is not applicable to a csv file.

c. Select up to three columns for sorting in an ascending or descending order.
When the system processes the Work Items from the queue, it uses the sort criteria specified
to retrieve the work items in that order. For example, to process payslips with first Employee
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ID followed by Employee Name from 1 to n and A to Z, specify Employee ID and Employee
Name in an ascending order.

Nota:  Work items are processed on sorting order internally. For example, if you add 3 work
items a, c, b to be sorted by name, then on the user interface they will be shown as a, c, b.
However, the work items will be processed as per the sorting order a, b, c.

• Use work item template: Add header columns by searching for an Existing work item
template or from the Available work item templates.
This allows you to pass the values or attributes from the template to a TaskBot with the help of
Work Item variables when you use the option Run bot with queue.

Suggerimento:  Search for an existing Work Item template when there are a large number of
templates available for selection.

Use Work Item variables alla pagina 2038
• Manually: Define the Work Item structure manually. You do not have to select from an existing

structure.
a. Type a name for the Work Item structure in the Work item template field.

For example, if the queue contains employee information, add the Work item template as
Employee Data.

b. Add column header names for the Work Item and select the data type for each column: Text,
Number, or Date

c. Select the display and sorting for the columns in the Control Room.
When the system processes the Work Items from the queue, it uses the sort criteria specified
to retrieve the work items in that order. For example, to process payslips with first Employee
ID followed by Employee Name from 1 to n and A to Z, specify Employee ID and Employee
Name in an ascending order.

2. Click Next to add the Work Items.
Insert Work Items alla pagina 2805

Riferimenti correlati
Work item status and actions alla pagina 2824
Based on the Work Item status, you can do only certain actions on a Work Item.

Insert Work Items
Add Work Items from an Excel or CSV file to the queue after you define the structure.
Ensure that you are logged in to the  as the administrator.
Add Work Items from an Excel or CSV file to the queue.

Nota:  When you upload work items from an xls or xlsx file with data type as text, the Excel file column
populated with a date in any format (for example, 8/6/2019) is converted to its corresponding workload
management date format (for example, Sat Jun 08 00:00:00) in the Control Room Work Item. However,
the same is not applicable to a CSV file.

You can also add Work Items later by editing the queue, see Modifica code alla pagina 2813.
1. Fai clic su Sfoglia.
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2. Select the Excel or CSV file.
3. Opzionale: Select the Disallow duplicates check box.

Nota:
• Only unique work items from the CSV file are added. If the CSV file contains any duplicate work

items, then the entire CSV file is ignored.
• This option is available only when you create a new queue.

4. Click Create queue.

• Now that you have created a queue, it is now ready for deployment from a bot.
Esegui bot con coda alla pagina 2807
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• Manage Work Items of a queue to fix the discrepancies before queue processing and reduce your
automation-related errors.
Gestisci Work Items alla pagina 2824

Esegui bot con coda
Puoi elaborare collettivamente tutti gli elementi di lavoro di una coda in tutti i Bot Runners presenti in uno
o più pool di dispositivi.
To run a bot with queue, ensure that you are allocated a combination of any or all of the following roles
and permissions:

Tipo di funzionalità Privilegi

Ruoli utente • AAE_Queue_Admin
• AAE_Pool_Admin

Autorizzazioni per le attività • Visualizza la mia Attività in corso
• Visualizza i miei bot pianificati
• Pianifica i miei bot per l’esecuzione
• Visualizza e gestisci tutta l'attività

programmata dalle mie cartelle

Autorizzazioni per i dispositivi • Visualizza e gestisci Bot Creator, Bot Runner
e i miei pool di dispositivi

• Crea pool di dispositivi
• Amministra tutti i pool di dispositivi

Autorizzazione per i bot • Visualizza i miei bots
• Esegui i miei bots

Autorizzazioni per il carico di lavoro • Visualizza e gestisci le mie code
• Crea code
• Gestisci tutte le code

Per Esegui bot con coda, procedi nel modo seguente:
• Puoi eseguire bots solo su Bot Runners non assistiti. Non puoi eseguire bots su Bot Runners assistiti

dalla Control Room.
• I bots devono essere archiviati nella cartella pubblica per consentire ai bots di qualificarsi per

l'esecuzione con coda.
• Work item sorting is done on the batch added to the queue. For example, if you add 2 batches of work

items a, c, b and a, c, b to be sorted by name, the work items will be processed for queuing as a, b, c
and a, b, c.
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• If you use the same device pool for inserting and processing work items for the same queue, you will
see duplicate entries in the In-progress activity and Historical page. To resolve this issue, use one
device pool to insert work items and a different device pool to process work items in a queue.

Utilizza l'opzione Esegui bot con coda da una delle seguenti pagine:
a. Attività > In corso
b. Gestisci > Programmato
c. Gestisci > Dispositivi
d. Gestisci > Pool di dispositivi
e. Gestisci > Code

The procedure for running a bot with a queue is the same in all these pages.
1. Seleziona il bot da eseguire con la coda.

• Versione più aggiornata: Fai clic sulla scheda Versione più aggiornata per selezionare la versione
più aggiornata del bot.

• Versione con etichetta: Fai clic sulla Versione di produzione per selezionare la versione con
etichetta del bot.

I bots disponibili vengono visualizzati insieme a tutti i Valori di input e alle dipendenze. Se l'opzione
etichetta di produzione è selezionata per il bot padre, vengono selezionati automaticamente anche i
corrispondenti bots dipendenti con l'etichetta di produzione. Se uno qualsiasi dei bots dipendenti non
ha l'etichetta di produzione applicata, viene selezionata la versione più aggiornata del bot.

2. Opzionale: Seleziona Esegui con privilegi da amministratore se il bot ha azioni che richiedono
privilegi da amministratore per essere eseguite.

3. Seleziona una coda con cui eseguire il bot.

Nota:  Ensure the following to see the list of available queues:
• You do not have the AAE_Admin role
• Your role is added to Queue > Consumers
• The bot and queue work item templates are identical

4. Opzionale: Set the queue running time.
a) Click Add running time in the Processing time tab.
b) Select the days from Days of the week field.
c) Enter the Start time and End time.
d) Click Add time to add another time period for the days selected.

You can add up to three time periods which cannot overlap with each other.
e) Click Add running time to add another running time and provide the day and time details.

You can add up to three running times. If the running time is not set, the queue runs for 24
hours.

f) Opzionale: Click Remove running time to delete any running time.
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5. Seleziona l'utente Bot Runner dall'elenco Esecutori di bot disponibili.
To enable a device, it must be connected to the Control Room.

Nota:  Se un dispositivo non appare nell'elenco, assicurati che all'utente che esegue i bots sia
assegnato un ruolo che consenta l'accesso al comando Esegui come utenti appropriato.

6. Opzionale: Seleziona l'opzione da eseguire sui dispositivi che eseguono i bot.
If you want to select Bot Runners that are mapped one-on-one with their default (single-user) devices,
select the Run on bot running devices option. This option enables the Work Items to be deployed
only to the user's default device, whereby the security policy does not allow a user to log in to any
other device or when applications for automation are installed on the default device.
If you select this option, ensure that all the default devices are part of the same device pool when you
select from the Device Pool tab.

Suggerimento:  Do not select this option if the run as users (Bot Runners) are configured to use
multiple devices. In that configuration, if any device in the pool is processing an automation, the
run as user can log in to another device, and the work items will be processed on that device. This
enables optimal utilization of licenses (run as user) and devices.

For information on scenarios for choosing bot running devices for run as users, see Considerations for
running a bot alla pagina 1995.

7. Select Device pools.
Select the pool from the list of available device pools.

8. Opzionale: Click the up or down arrow to set the selected device pools in preferred order.
Quando un  viene distribuito, la  seleziona il primo dispositivo disponibile in base all'ordine in cui
sono stati organizzati i pool di dispositivi. Se nessuno dei dispositivi è disponibile al momento della
distribuzione, il  viene messo in coda.

9. Seleziona la Priorità di automazione dalla scheda Generale.
Imposta la priorità su alta, media o bassa in base alle tue esigenze per l'ottimizzazione delle risorse. Il
valore predefinito è media.

10. Fai clic su Esegui bot con coda.

Nota:  If a user who created the WLM automation using the Run bot with queue option is deleted,
the automation is also affected and queues cannot be processed.

The following video demonstrates how to run a bot with queue.

Attività correlate
View automation of a queue alla pagina 2820
Use the View activity in progress page to view the automation details of the selected queue, Pause,
Resume, or Stop the in-progress automation.
Riferimenti correlati
Distribuzioni ed esecuzioni di bot concomitanti alla pagina 842
Rivedi le informazioni sul numero massimo di distribuzioni ed esecuzioni simultanee per bot relative alla
distribuzione On-Premises.

Add TaskBots and dependent files
Add a TaskBot, and review the input values and dependent files for the automation.
1. Navigate to Activity > Scheduled, Bots > My Bots, or Workload > Queues page.
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2. Click Run bot with queue
The Activity > Run bot with queues Create page is displayed.

3. Enter a name for the automation.
4. Opzionale: Immetti una descrizione.

For example, you can describe the purpose of running the TaskBot with a queue.
5. Go to the folder that contains the required TaskBot.
6. Select a TaskBot to process in the queue from the list.

• Versione più aggiornata: Fai clic sulla scheda Versione più aggiornata per selezionare la versione
più aggiornata del bot.

• Production label: Click Production label tab to select the labeled version of the bot.

By default, the Bots folder is selected.

Suggerimento:  Use the search field to find a TaskBot quickly.

The Input values and Dependencies options are displayed at the bottom of the page.
Se l'opzione etichetta di produzione è selezionata per il bot padre, vengono selezionati
automaticamente anche i corrispondenti bots dipendenti con l'etichetta di produzione. Se uno qualsiasi
dei bots dipendenti non ha l'etichetta di produzione applicata, viene selezionata la versione più
aggiornata del bot.

7. Opzionale: Select the Input values check box to add the values of variables to the bot during
runtime.
This is enabled only if the selected TaskBot has Input values.

Nota:  In workload automation, input to the bot is provided by the workload queue, the input type
variable is not supported in workload automation.

8. Opzionale: Review the list of dependent files, if available.
This list is enabled only if the selected TaskBot has dependencies. The TaskBot dependencies that are
uploaded in the Control Room are available only for review.

9. Click Next to add a queue, Bot Runner and device pool.
Add queue, Bot Runner, and device pool alla pagina 2810

If the selected TaskBot does not contain a work item template, an error message appears at the top of the
page. The TaskBot also shows an icon to indicate a missing work item template.
Define Work Item structure alla pagina 2803
Riferimenti correlati
Bot dependencies alla pagina 2046
Bots dependencies are files and other bots that are required to run that bot successfully.

Add queue, Bot Runner, and device pool
Add a queue, Bot Runner, and device pool to the automation from the Run bot with queue page.
Ensure that you are logged in to the  as the administrator.
Automation processes are queued until the specified Run as user and devices become available. Queuing
permits other automation processes for that specific Run as user until the specified device becomes
available. Any In use queues are shown as disabled in the Available queues list.
You can deploy the automation on the number of users that you choose with the Run as option and not
on the total number of devices available in a device pool. Select only those queues that are not in use.
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Nota:  You cannot use multiple queues to add Bot Runners.

1. Select a Queue from the Queues list.
The queues for which you have consumer access and same work item template as the selected bot
are listed.

2. Fai clic su Avanti.
3. In the Run as tab, from the Available bot runners list, select a Bot Runner.

a) Opzionale: Select the Run on bot running devices option.
If you want to select Bot Runners that are mapped one-on-one to their default (single-user)
devices, select the Run on bot running devices option. This option enables the Work Items to
be deployed only to the user's default device, whereby the security policy does not allow a user to
log in to any other device or when applications for automation are installed on the default device.
If you select this option, ensure that all the default devices are part of the same device pool when
you select from the Device Pool tab in Step 5.

Suggerimento:  Do not select this option if the run as users (Bot Runners) are configured to
use multiple devices. In that configuration, if any device in the pool is processing an automation,
the run as user can log in to another device, and the work items will be processed on that device.
This enables optimal utilization of licenses (run as user) and devices.

For information on scenarios for choosing bot running devices for run as users, see Considerations
for running a bot alla pagina 1995.

4. Fai clic su Avanti.
5. In the Device pool tab, select a Device Pool from the Available device pools list.
6. Fai clic su Aggiungi.

The queue and device pool are added to the run bot with the queue list.
7. Opzionale: Click Remove to replace the queue or the device.
8. Fai clic su Esegui bot con coda.

The queue status changes to In use on the Queues page.

Concetti correlati
Considerations for running a bot alla pagina 1995
There are certain considerations you have to keep in mind when running a bot.

Manage workload queues
For workload maintenance tasks such as view the details of queues to pause, stop, or resume its
automation, edit the queues, manage the work items in the queue, and delete the queues.

Nota:  In a multi-user environment, if there are two queues A and B, and multiple work items are in
queue A, the device will process work items in queue A first, and then move to queue B. To process both
the queues in parallel in a multi-user environment, you must perform one of the following actions:
• Add another device to the existing device pool.
• Create another device pool on the same device.
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Workload maintenance tasks

For workload automation maintenance, do the following (in any order):

View queue details alla pagina 2812 Use the View queues details page to view the
details of a particular queue.

Modifica code alla pagina 2813 Puoi modificare una coda utilizzando due metodi:
dall'elenco Code o dalla pagina Visualizza coda.

Delete queues alla pagina 2817 Delete a selected queue, multiple selected queues,
or all queues of work items.

Gestisci Work Items alla pagina 2824 Manage Work Items of a queue to fix the
discrepancies before queue processing and reduce
your automation-related errors.

Riferimenti correlati
Actions allowed on view queue page alla pagina 2818
Use different actions such as sorting, searching, or filtering on the table view of the queues.

View queue details
Use the View queues details page to view the details of a particular queue.
Ensure that you are logged in to the  as the administrator.
Autorizzazioni richieste:
1. Queue Owner or Queue Participant or Consumer rights
2. View and manage my Queues feature permission
3. A user with AAE_Admin role can view all the queues and manage (pause, resume, and stop) all the

WLM automations.

Nota:  If you are not an owner, participant, or consumer of that queue, you can view only queue
names and not the queue details.

The View queues page shows the following queue details:
• New when the work item is added to the queue recently.
• On hold when the work item is deferred from processing by a Queue owner, participant, or consumer.
• Failed when the work item processing failed on an unattended bot.
• Completed when the work item is successfully processed by a Bot Runner or marked Completed by a

queue owner, participant or consumer.
• Data error when there is an error in loading data from the file.
• Active when the work item is currently being processed or staged for processing.
• Ready to run when the work item is successfully processed for execution does not have any data

errors and can be staged for processing.

Queue contents in different tabs such as:
1. Work Items: This is the default view. This allows you to view all work items in a tabulated form. You

can use the filter go view specific work items. For example, all work items with status as Completed.
You can View, Edit, or Delete the individual work items in each row. You can also change the status
of the work items in bulk. For example, change the status of all the work items in Data error to On
hold.

© 2023 Automation Anywhere. All rights reserved.     2812



    Automation Anywhere - Gestisci

2. General: View the Reactivation Threshold and Time required to complete one work item.
3. Owners: View the user names of queue owners who can edit the queue and add new work items.
4. Participants: View the user names of queue participants who can add new work items and view the

queue.
5. Consumers: View the user names of consumers who can view the queue and all the work items in

the queue. In addition, they can use this queue when running bots.
6. Work Item Structure: View the work item structure that you defined when creating the queue.

Suggerimento:  Edit any of these details by either clicking the edit this queue link or the Edit button.
Also, delete the queue by clicking the Delete button.

1. Navigate to Manage > Queues.
2. Hover over the Actions icon for the queue.
3. Click View.

View automation of a queue alla pagina 2820
Concetti correlati
Gestisci Work Items alla pagina 2824
Manage Work Items of a queue to fix the discrepancies before queue processing and reduce your
automation-related errors.
Attività correlate
Crea code alla pagina 2801
Create queues that hold specific sets of data your bot is expecting for automation. To create queues, an
Control Room administrator assigns the AAE_Queue Admin role with View and manage my queues,
Create queues, Administer all queues, and View my in progress activity permissions.
Modifica code alla pagina 2813
Puoi modificare una coda utilizzando due metodi: dall'elenco Code o dalla pagina Visualizza coda.
Delete queues alla pagina 2817
Delete a selected queue, multiple selected queues, or all queues of work items.
Riferimenti correlati
Actions allowed on view queue page alla pagina 2818
Use different actions such as sorting, searching, or filtering on the table view of the queues.

Modifica code
Puoi modificare una coda utilizzando due metodi: dall'elenco Code o dalla pagina Visualizza coda.
Ensure that you are logged in to the  as the administrator.
Autorizzazioni richieste:
1. Ruolo Admin AAE_Queue.
2. Diritti Proprietario coda per modificare le code che hai creato.
3. Diritti Partecipante coda per modificare le code create da altri proprietari di code.

Puoi modificare un elemento di lavoro solo se si trova in uno stato Nuovo, Errore dati, In attesa,
Pronto per l'esecuzione o Non riuscito.
Modifica una coda dalla pagina Visualizza coda o dall'elenco Code.
1. Navigate to Manage > Queues.
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2. Hover over the Actions icon for the queue.
3. Click the Edit icon. ( )
4. Click one of the following options to launch the Edit Queue page.

• Collegamento modifica questa coda.
• Pulsante Modifica.

5. Edit the queue details, such as queue name (applicable only if in draft), description, work items,
threshold and time values, auto retry attempt (applicable only if queue is not in use), owners,
participants, and consumers.

Nota:
• La struttura Elemento di lavoro non può essere modificata dopo la definizione.
• When you edit a queue and set new auto retry number, the new number is only applicable to the

new failed work items. If the queue owner changes the auto retry attempt value to a number less
than the existing number, the work item will not be retried.

• Il nome coda deve essere univoco e non deve essere condiviso con un'altra coda.

6. Carica un file per l'elemento di lavoro che verrà utilizzato per l'elaborazione in questa coda.
Per impostazione predefinita, viene visualizzata la scheda Elementi di lavoro.

Suggerimento:  Puoi cercare un elemento di lavoro in modo rapido in base a Stato o Dettagli
stato utilizzando l'opzione di ricerca.

7. Fai clic su Sfoglia.
8. Seleziona il file da caricare.

Nota:  Puoi caricare solo un file Excel o CSV.
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9. Opzionale: Put work items on hold.
a) Select the work items and click On hold from the table level icons list.

b) In the To update screen, select one of the following options:
• Indefinitely: The work item is put on hold until you manually move it for re-processing.
• Until: The work item is put on hold until the specified date and time. Enter the Date, Time,

and Time zone in their respective fields.
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c) Click Yes, change.
The selected work items are put on hold.

Nota:  The column On hold until in the Edit queue page displays the work item hold status
(indefinitely or specific date and time). The status of the work items which are not on hold are shown
as N/A.

10. Fai clic su Salva modifiche.
11. Modifica il nome e salva le modifiche apportate alla coda.

Viene visualizzato un messaggio di modifica riuscita.

Concetti correlati
Gestisci Work Items alla pagina 2824
Manage Work Items of a queue to fix the discrepancies before queue processing and reduce your
automation-related errors.
Attività correlate
Crea code alla pagina 2801
Create queues that hold specific sets of data your bot is expecting for automation. To create queues, an
Control Room administrator assigns the AAE_Queue Admin role with View and manage my queues,
Create queues, Administer all queues, and View my in progress activity permissions.
Riferimenti correlati
Actions allowed on view queue page alla pagina 2818
Use different actions such as sorting, searching, or filtering on the table view of the queues.
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Delete queues
Delete a selected queue, multiple selected queues, or all queues of work items.
You must have the following rights and permissions to complete the task. Ensure you are logged in to the
Control Room as the administrator. To complete the task, you must have AAE_Queue Admin role and
Queue Owner permission assigned to you.

Nota:  You cannot delete a queue if it is being used for processing a work item. An error message appears
for that particular queue.

1. Accedi a Control Room.
2. Go to Manage → Queues.
3. Use one of the following options to delete selected or multiple queues:

Opzione Fasi

Delete selected queue a. Hover over a queue to delete.
b. Click the Actions menu.
c. Click the Delete button.

A confirmation message to permanently
delete the queue appears.

d. Click Yes, delete to confirm or No, cancel
to discard the action.
A confirmation message appears after you
delete the queue.

Delete multiple selected or all queues a. Select the check box of required queues or
select the check box given in the header to
select all queues.

b. Click the Delete button above the header.
A confirmation message to permanently
delete multiple queues appear.

c. Click Yes, delete to confirm or No, cancel
to discard the action.
A confirmation message appears after you
delete the queue.

Attività correlate
View queue details alla pagina 2812
Use the View queues details page to view the details of a particular queue.
View automation of a queue alla pagina 2820
Use the View activity in progress page to view the automation details of the selected queue, Pause,
Resume, or Stop the in-progress automation.
Modifica code alla pagina 2813
Puoi modificare una coda utilizzando due metodi: dall'elenco Code o dalla pagina Visualizza coda.
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Actions allowed on view queue page
Use different actions such as sorting, searching, or filtering on the table view of the queues.

Searching and filtering

For ease of access, apply search parameters to ID, Start Time, Work item result, Status, and Queue
Name columns.
• Specify the search parameters in the search bar for Queue Name. When you specify search

parameters for the same column, the system searches using OR operator. When you specify search
parameters for different columns, the system searches using AND operator.

• Choose the search parameters from a list in the search bar for Work Item Status.
• Apply filters to Work Item Result to quickly track the final status of the work item. For example if the

work item was completed or skipped.
• Use the Work Item ID to search for specific work items and combine with the Start Time to monitor

the progress of the work items that you search based on the ID. The Start Time filters the list of all
work items that start between two given Start Date and Start Time. For example, all work items
started between 01/08/2021 13:00 hrs. and 31/08/2021 15:00 hrs.

Nota:  Use a hyphen (-) as separator between IDs as any other symbol gives an error. For example,
100-250.

Table items

The following describes the list of items that can be viewed in the table:

Table Item Descrizione

ID Shows the system generated id for a work item.
When a work item is added to a queue, system
generates an id for that work item.

Stato Shows Work item status:
Use the View queues details page to view the
details of a particular queue.

Start Time and End Time Shows the work item's processing start/end time
and date.

Modifica di Shows the name of the last user who had
modified the work item.

Ultima modifica Shows the time and date when the work item
was modified last.

Nota:  Apart from the above system generated columns, the fields that you define in your work item are
also displayed as columns.
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Actions on table column

Use the following actions on a table column:
• Click a column to sort it in ascending and descending order. You can sort up to three columns by

holding the Shift key when you click two more columns. This gives you the option of sorting two
additional columns. This way the sorting is done on the entire table and not just the data that is
currently visible to you. The last sorting is stored in memory applied by a user per session.

• Drag a column to the left or right
• Move your mouse cursor at the end of the column and drag to re-size

Actions on work items

Use the following tasks on specific work items:

Table Item Descrizione

Aggiorna Allows you to refresh the table contents so that
you can view the latest work item status

Elimina Allows you to delete one or multiple work items.

Segna come completato Allows you to mark one or more work items
as Complete whose status is On hold, Data
Error, or Ready to run.

Nuovo Allows you to mark one or more work items as
New whose status is On hold, or Data Error

In attesa Allows you to mark one or more work items as
On hold whose status is New

Personalizza colonne Allows you to show or hide specific columns. By
default, all columns are displayed including the
ones defined in the work item.

Alternately, select work items and use the following actions. Note that these actions can be performed only
at a table level and not on individual work items.

Table Item Descrizione

Visualizza Allows you to view details of selected work item.

Modifica Allows you to edit details of selected work item.
You can see this icon only if you are the Queue
Owner or Participant or Consumer and the
status of the work item is Unsuccessful, On
hold, or Data error

Elimina Allows you to delete the selected work item.
Note that if a work item is in Active state, you
are not allowed to delete it.

Attività correlate
Define Work Item structure alla pagina 2803
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Define the Work Item structure for processing in a queue. This enables you to manually upload the Work
Items from the system in the absence of ready data in a file.

View automation of a queue
Use the View activity in progress page to view the automation details of the selected queue, Pause,
Resume, or Stop the in-progress automation.
You must have the following rights and permissions to complete the task. Ensure you are logged in to
the Control Room as the administrator. To complete the task, you must have the following permissions
assigned to you:
• AAE_Queue Admin role
• Queue Consumer or Queue Participant rights
• Manage everyone's In progress activity feature permission
• View and manage all scheduled activity from my folders activity permission (if you have access

to the folder which has the WLM bot)
• View and manage all scheduled activity permission (if you do not have access to the folder which

has the WLM bot)

Nota:
• Though the View automation page is accessible from the Workload module, the page is launched

from the Activity module.
• You cannot Pause/Resume or Stop actions directly from the Activity > In progress page. For these

actions, the Manage > Queues > View automation action is used.

1. Accedi a Control Room.
2. Go to Manage → Queues.
3. Hover over a queue with status In use.
4. Click the Actions menu (vertical ellipsis) and select View automation.

This launches the Activity > Run bot with queue > View page.
5. Choose one of the following options to view automation of a queue:

Opzioni Descrizione

Automation details of the queue • The Bot name, path, dependencies, and if it
requires administrative privileges to run in the
Task Bot tab.

• The Queue used to run the automation in the
Queue tab.

• Bot Runner details such as username, device,
and user status in the Run as tab.

• Details of the device pool in use to run the
automation in the Device pool tab.

• Details such as number of work items that
were active, failed, pending, or completed
processing in the Run history tab.
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Opzioni Descrizione

Metti in pausa The system pauses the distribution of work items
from this queue to available bot runners in the
device pool.

Nota:  Until you resume this automation, any
work items with Ready to Run status from this
queue are not sent for processing.

Riprendi The system starts distributing the work items
from this queue.

Sospendi • The system stops distributing the work
items from the queue associated with this
automation.

• Select No, cancel to return to the details
page or Yes, stop to stop the work item
processing and return to the Queues page.

Modifica code alla pagina 2813
Attività correlate
View queue details alla pagina 2812
Use the View queues details page to view the details of a particular queue.
Delete queues alla pagina 2817
Delete a selected queue, multiple selected queues, or all queues of work items.

Esporta code
Export queues for flexible usage that ensures efficient processing of WLM automations. With export
queues feature, you can reuse queues across environments such as Dev, QA, and production.
• You must have the AAE_Queue_Admin role to export queues.
• Ensure that the target Control Room user has create users, create roles, and install license permissions.
• The source and target Control Room instances must be running the same version.
• The source and target Control Room instances must be of same setup type: SSO with SSO, AD with AD,

and non-AD with non-AD.
• To receive an email notification on successful export of a queue, ensure that the following notification

is selected in Administration > Settings > Email: A BLM package is exported or imported, to
the user who performed BLM export or import.
For more information see Modifica notifiche via e-mail alla pagina 2750.

When exporting a queue, consider the following factors:
• You can export only the queues that are in the Not in use state. The queues in the New or Draft state

cannot be exported.
• Before you export a queue, you must pause all the running WLM automations or queues.
• All the queue entities associated with the queue, for example, general settings, owners, participants,

consumers, Work Item structure, and optionally Work Items are exported to your Control Room.

To export a queue, perform the following steps:
1. Navigate to Manage > Queues.
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2. Select the required queue and click Export queues.
3. In the Export queues page, select a queue that you want to export, click the right arrow (→), and

then click Next.
You can select the Include work items option to export work items along with the queues. By
default, the Include work items option is not selected.

Nota:  When you export a queue along with a large number of work items, the export or import
process might take time up to 30 minutes.

4. In the General section on the left pane, perform the following steps:
a) Richiesto: Specify an Export namefor the queue that you want to export.
b) Opzionale: Specify a password for the exported queue.

If you specify a password, confirm the password in the Confirm password field.

5. Click Export queues.
The selected queue is exported and available in the Activity > Historical page. The exported queue
is in the following file format: Queue Export:Export.Queues.20220715_162251.<<username>>

Nota:  If Automation 360 is email-enabled and the A BLM package is exported or imported, to
the user who performed BLM export or import. notification in Settings > Email is selected, an
email notification is sent to your registered email ID. The email body contains a link to the Activity >
Historical page to download the exported queue.
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6. Select the queue and click Download exported zip file.

The exported queue zip file is downloaded to your local system, with details such as Queue general
settings, Queue work item template, and Work items (if included during export).

Nota:  Data such as queue owners, consumers, and participants is not exported.

Importa code
Import queues for flexible usage that ensures efficient processing of WLM automations. You can also
import queues along with work items.
• You must have the AAE_Queue_Admin role to import queues.
• Users and roles associated with the queues are imported, and the license assigned to the users is also

imported.
• Ensure that the target Control Room user has create users, create roles, and install license permissions.
• Ensure that queue names are unique for importing. Queues with the same name are skipped and not

imported in the target Control Room.
• The source and target Control Room instances must be running the same version.
• The source and target Control Room instances must be of same setup type: SSO with SSO, AD with AD,

and non-AD with non-AD.

When importing a queue, consider the following factors:
• Before you import a queue, you must pause all the running WLM automations or queues.
• Users and roles associated with the queues are imported. Licenses (for example, Bot Creator and Bot

Runner) that are assigned to the users associated with the queues are also imported.
• All the queue entities associated with the queue, for example, general settings, owners, participants,

consumers, Work Item structure, and optionally Work Items are imported to your Control Room.
• When you import Work Items with the queues, the state of the Work Items (Completed, Failed, Data

error, and so on) are maintained in your target Control Room.

To import a queue, perform the following steps:
1. Navigate to Manage > Queues.
2. Select the required queue and click Import queues.
3. In the Import queues page, click Browse to select the required queue from your local system.
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4. Opzionale: Enter a password for the queue that you want to import.
If a queue already exists in your environment, you can select one of the following options:
• Skip the queue (don't import it): The selected queue is skipped and is not imported.
• Make a copy of the queue (a suffix of “copy” will be added to the queue name): A copy

of selected queue is created and imported to your environment, with copy suffixed to the name of
the queue.

5. Click Import queues.
The selected queue is imported and available in the Manage > Queues

page.

Gestisci Work Items
Manage Work Items of a queue to fix the discrepancies before queue processing and reduce your
automation-related errors.

Permissions required

You need any of the following permissions to manage the work items:
1. AAE_Queue Admin role
2. View and manage my Queues feature permission
3. Queue Owner, Queue Consumer, and/or Queue Participant permissions

Work item status and actions
Based on the Work Item status, you can do only certain actions on a Work Item.
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Work item - status and actions

The following table provides a description of each Work Item status and the action you can do on a Work
Item having that status:

Work Item Status Descrizione Azioni

Nuovo New Work Item is added View, Edit, and Delete

Pronto Work Item is successfully
processed for execution

View, Edit, and Delete

Attivo Work Item is currently being
processed

Visualizza

Completato Work Item successfully
processed by a Bot Runner

View and Delete

Operazione non riuscita Work Item processing has failed
to execute on unattended Bot
Runners

View and Edit

Data Error Data type mismatch when
adding Work Items to the queue

View, Edit, and Delete

In attesa Work Item is deferred for use
by the Queue admin

View, Edit, and Delete

Attività correlate
Edit work items alla pagina 2826
Use the Queues page or the Work item page to edit the work items of a queue.
Define Work Item structure alla pagina 2803
Define the Work Item structure for processing in a queue. This enables you to manually upload the Work
Items from the system in the absence of ready data in a file.

View work items
View work items with a status of Completed, Unsuccessful, On hold, Active, or Data Error in the View
work item page.
Ensure that you are logged in to the  as the administrator.
From the Workload > Queues page, you can perform the following actions on either one queue or
multiple queues, including:
• Elimina: This will delete the work item permanently.
• Mark complete: This will mark the work item as complete.
• Re-process:This will mark the work item in New state.
• On hold: This will mark the work item as On hold.

Nota:  The Start time and End time are shown when the work item is being processed.

Select a queue to View, Edit, or Delete a queue.
1. Navigate to Manage > Queues.
2. Hover over the Actions icon for the queue.
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3. Click View.

Edit work items alla pagina 2826
Delete work items alla pagina 2826
Riferimenti correlati
Work item status and actions alla pagina 2824
Based on the Work Item status, you can do only certain actions on a Work Item.

Edit work items
Use the Queues page or the Work item page to edit the work items of a queue.
Ensure that you are logged in to the  as the administrator.
You can edit a work item only if it is in a New, On hold, Data error, or Failed state.
1. Navigate to Manage > Queues.
2. Hover over the Actions icon for the queue.
3. Click the Edit icon. ( )
4. Select one of the following options to filter the work items.

• Status
• Id
• Nome
• Work item result

5. Change the work item status to Mark complete, Defer, or Re-process in the Work item
attributes and automation details section.
You can reprocess the failed Work Items by editing and modifying from Failed to Re-process.
The system will set the status to Data Error during the data load if there is any issue with the data.
For example, if a user enters a text value for a number field, or an invalid date string for an attribute
of date type, the status will be displayed as Data Error.
Work item status and actions alla pagina 2824

6. Fai clic su Salva modifiche.

Delete work items alla pagina 2826

Delete work items
Delete work items one at a time or in bulk in the View work item page.
Ensure that you are logged in to the  as the administrator.
You can delete a work item only if it is in a Data error, On hold, Ready to run, Complete, or Failed
state. For work items in the Ready to run state, the work item should not be in a queued state. To delete
such work items, Pause the automation.

Nota:  You can also delete a work item one at a time or in bulk using the Delete option provided above
the Work items table.

1. Navigate to Manage > Queues.
2. Select the queue.
3. Hover over the Actions icon for the queue.
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4. Click Delete.
Confirm or cancel.

Riferimenti correlati
Work item status and actions alla pagina 2824
Based on the Work Item status, you can do only certain actions on a Work Item.

Export work items to CSV file
Export work items to a CSV file for offline audits and records. The CSV file with the exported work items is
available for download in the Activity > Historical page.
• You must have the AAE_Queue_Admin role to export or import work items.
• The source and the target Control Room instances must be running the same version.
• The source and the target Control Room instances must be of the same setup type: SSO with SSO, AD

with AD, and non-AD with non-AD.

You can export selected, filtered, or all work items to a CSV file by using the following options:
• Export checked items
• Export filtered items
• Export all items

1. Navigate to Manage > Queues.
2. Click the required queue and go to the Work items.

A list of available work items is displayed.
3. Click the Export items to CSV icon.

( )
4. Click one of the following required options:

• Export checked items: Exports only the selected work items

Nota:  You must select items to use this option.

• Export filtered items: Exports only the filtered work items
• Export all items: Exports all the available work items

A message is displayed, informing that the exported CSV file is available in the Activity > Historical
page.
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5. Navigate to the Activity > Historical page and search for exported work items activity.

Nota:  You can search for a work item activity by the username. The work item activity name is in the
following format: Work items Export:cr-work-items-20220713-104704.csv. You can change the work item
activity name by using File > Save.

6. Select the work item activity and click Download exported CSV file.
The CSV file is downloaded to your local system as a zip file.

Workload guidelines
To optimally use your work items and queues in Automation 360, review the guidelines.

Do's

• Ensure that the queue has at least 2 owners so that there is no deadlock if an owner is deleted or
disabled.

• If work items are added frequently to a queue, set the reactivation threshold to 1 so that when a work
item is added, the work item is added quickly.

• Up to 10 work item columns can be displayed in the Control Room. Use this feature to get maximum
visibility in to your work item data.

• Optimally use work item values that can accept up to 1000 characters, especially for work item result
values.

• To prioritize certain work items, ensure that you sort the work item data when you create queues.
• To insert work items in a loop, use the v3/wlm/workitems API because this API accepts a list of work

items in JSON format.
• Ensure that the time (clocks) in all the machines in a cluster are synchronized. This is important for the

Apache Ignite cache server to function properly.
• Persistent and continual database connectivity is critical for the functioning of workload automation.

Therefore, ensure that you perform a periodic network scan or use tools that can detect or avoid
network issues.

• Apply the pagination filter to retrieve more than 200 work items when you retrieve them using the work
item API.

"page":
                    { 
                    "offset":0,
                    "length":1000
                    }

Don'ts

• To ensure the system works efficiently, do not use the v3/WLM/workitems API in a loop to insert
work items in bulk.

• If the Bot Runner is part of a device pool, do not create local schedules on that Bot Runner so that the
Bot Runner runs only the work items.

• If a user has a queue in use, do not remove the Run bot permission from that user (role).
• If a work item is in progress, do not shut down a Bot Runner.

To take a Bot Runner offline for maintenance, ensure that you pause the queue and verify no work item
is in progress on the Bot Runner.
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• If a work item queue is being processed, do not stop or restart the Automation Anywhere Control Room
Service. Instead, pause the queue automation, and then restart the service.

Working with repositories, credentials and roles
Control room administrators configure repositories for Bot Creators to develop RPA bots. Administrators
create roles, assign users, and grants permission to action packages used in creating bots.
This topic is intended for experienced Automation Anywhere Automation 360 users.

Administrator tasks

Control room administrators setup repositories for Bot Creators to develop bots. For this process,
administrators create users and assign these users specific roles, such as Bot Creators or Bot Runners. Bot
Creators are granted access to specific RPA action packages to create, test, and run bots. Completed bots
are transferred to the public repository for other users to deploy. The following is a breakdown of control
room administrator related tasks to complete this process.

Set up your bot repository alla pagina 2830 Administrators create repositories for Bot Creators
to develop , test, and debug bots. After configuring
the repository, the administrator creates the role for
the Bot Creator.

Assign a role alla pagina 2708 Roles grant specific permissions to users, such as
Bot Creators and Bot Runners.

Create your users and assign their licensed roles alla
pagina 2830

Create or otherwise edit the user information to
assign the licensed role for accessing repositories,
packages, and bot building tools and functionality.

Add packages to the Control Room alla pagina 2649 Administrators can add packages to the Control
Room for use by Bot Creators.

Set up lockers and credentials in Credential Vault alla
pagina 2840

The credentials assigned are typically those
where the administrator is granting some internal,
business-related access to a Bot Creator or Bot
Runner for RPA development, for example to a
Salesforce account.

Bot Creator task

Bot Creators often require access to protected data to automate a process. Each Bot Creator is given
credentials governing the data they are permitted to access. The administrator creates the credential and
assigns it to individual users by configuring specific roles for the Bot Creator to access those credentials.
Bot Creators must add their own specific attributes to the credentials after they have been assigned by the
administrator.

Manage user credentials
Bot Creators and Bot Runners rely on credentials to access necessary data relevant to the bot building
process.
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Questa attività viene eseguita dall'utente che desidera creare e distribuire . Devi disporre dei diritti e delle
autorizzazioni necessarie per completare questa attività, nonché dell'autorizzazione per accedere alla  come
utente con licenza.
Bot Creators often require access to protected data to automate a process. Each Bot Creator is given
credentials governing the data they are permitted to access.

Nota:  Administrators are required to have created the necessary roles and entitlements assigned to the
user in order to update and use any granted permissions.

1. Navigate to Bots > Credentials > My Credentials.
Select the credential to view and or manage.

2. Fai clic su Modifica.
The configurable fields for the credential are displayed, based on the user granted permissions.
For example, a bot is built that requires the authentication username and password to log in to a
specific URL. The user will create a custom credential for this operation by amending the credential
governed by the administrator, adding the additional security details. This way, the Bot Creator can
authorize only that protected data deemed necessary for the automation.

3. Fai clic su Salva modifiche.

Set up your bot repository
Administrators create repositories for Bot Creators to develop and build bots.
Ensure that you are logged in to the  as the administrator.
Administrators create repositories for Bot Creators to develop , test, and debug bots. After configuring the
repository, the administrator creates the role for the Bot Creator.
1. Log in to the  as the administrator.
2. Nel pannello di sinistra, fai clic su Automazione.
3. Click Create subfolder.
4. Provide the repository folder name and navigation path.

This repository folder is where the bots created by Bot Creators will be stored.

Important:  Based on limits requirement in the Windows operating system (primarily Windows
Server 2019 and 2016), ensure your folder, file names, and the nested folder structure is not long;
otherwise, your bot execution or repository backup can be impacted.

5. Fai clic su Crea cartella.

Create roles for users. Roles grant specific permissions to users, such as Bot Creators and Bot Runners.

Create your users and assign their licensed roles
Crea un utente e assegna il suo ruolo specifico basato su licenza.
Ensure that you are logged in to the  as the administrator.
Create or otherwise edit the user information to assign the licensed role for accessing repositories,
packages, and bot building tools and functionality.
1. Accedi ad Amministrazione > Utenti.
2. Fai clic su Crea utente.
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3. Enter the required general details as follows:

Campo Valore

Abilita utente Select for the user to be activated and log in
immediately.

Nota:  If this option is not selected, user will be
in the inactive state and cannot log in.

Nome utente Inserisci un nome utente univoco.

Descrizione Inserisci una descrizione per l'utente.

Nome Immetti il nome dell'utente.

Nota:  The number of characters allowed in the
First name field is 50.

Cognome Immetti il cognome dell'utente.

Nota:  The number of characters allowed in the
Last name field is 50.

Password Enter and confirm a password for the user.
Ensure that the password follows all the
necessary password policies.

E-mail Inserisci e conferma l'indirizzo e-mail dell'utente.
If SMTP is enabled, an email is sent to this
address to confirm the account. All important
Control Room notifications are sent to this email
address.

4. Select the required role from the list of Available roles.
5. Click the right arrow (→) to add your selection.
6. Select Allow to allow multiple sessions.

You must be Control Room administrator to set a user as a multi-login service user. It is possible to set
a user as a multi-login user either in the UI or API, however a user may only access multiple sessions
through the API.

7. Assign the device Bot Creator license to the user.
The Bot Creator license enables user to create and run bots. Auto login is enabled by default.

Nota:  When you logged in as administrator, you cannot allocate any device license to the user and
None option is selected by default.

Licenza Privilegi

Nessuno The user can access the Control Room only.

Bot Creator- Development license Enables user to create and run bots. Auto login is
enabled by default.
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Licenza Privilegi

Bot Runner non assistito - Licenza di
runtime

Gli utenti con questa licenza possono eseguire
tutte le attività di automazione che gli utenti
assistiti possono eseguire. Inoltre, questa licenza
può essere utilizzata anche per la distribuzione
della Control Room, la programmazione
centralizzata e la distribuzione basata su API.

Bot Runner assistito - Licenza di runtime Gli utenti con questa licenza possono eseguire
bots sui loro dispositivi e utilizzare qualsiasi
trigger di eventi associato al loro account utente
o ruolo. Tuttavia, questi utenti non possono
programmare bots.

Citizen Developer - Licenza di sviluppo Gli utenti con questa licenza possono creare ed
eseguire i bots (anche bots con trigger) sui loro
dispositivi.

L'opzione Ignora il disclaimer di limitazione della responsabilità viene abilitata
automaticamente per consentire all'utente di eseguire bots su un dispositivo senza dover accettare
manualmente una dichiarazione di non responsabilità.
Dopo aver selezionato una licenza per il dispositivo, le Credenziali di accesso del dispositivo sono
abilitate. Se disponi dell'autorizzazione Attesta credenziali dispositivo, puoi scegliere di attestare
le credenziali del dispositivo per questo utente per bypassare la convalida delle credenziali quando si
distribuiscono i bots. L'utente Bot Runner deve avere una sessione utente sbloccata e attiva.

Nota:  Questo funziona solo se l'impostazione di accesso automatico Riutilizza una sessione
esistente è selezionata nella Control Room dall'amministratore.

8. Fai clic su Crea utente.

Update the Bot Creator packages and grant permissions to this user to build, test, and run bots. For more
information, see
• Aggiornamenti automatici del package per On-Premises Control Room alla pagina 2726
• Automatic package updates for Cloud Control Room alla pagina 2727
• Autorizzazioni per le funzioni di un ruolo alla pagina 2694
• Bot permissions for a role alla pagina 2706

Bot Lifecycle Management
The Bot Lifecycle Management feature enables you to move a bot from one environment to another.
For example, you can move a bot from the development or testing environment to the production
environment.

Panoramica

Bot Lifecycle Management easily integrates with the DevOps workflow, which supports separate
development, testing, acceptance, and production environments and enables you to move bots along with
their dashboards from one environment to another.
Bot Lifecycle Management provides a framework for continuous testing and deployment of bots and
their dependencies in separate software development life cycle (SDLC) environments, allowing bots to
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seamlessly transition between lifecycle stages defined by an organization before they are released to
production.
You can use the feature to move bots within different environments and help you prevent failure or
disruption of data. You have to export a bot from one environment and then import it to another
environment to move it between environments. You can also bundle all the dependencies of a bot when
transitioning it through the different environments.
The following image shows a typical Bot Lifecycle Management workflow:

What is exported across environments

The following entities are included when you perform an export operation from one Control Room to
another:
• Bot file
• Dependent files
• Action packages and dependencies
• Dashboard di Bot Insight

The following entities are not included when you perform an export from one Control Room to another:
• Credentials and credential lockers
• Workload management queues
• Bot Runner accounts and permissions

Permissions required to export and import bots

To export bots from the Control Room, you must have the following permissions:
• Export bot and View packages feature permissions
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• Check in or Check out folder permissions

To import bots to the Control Room, you must have the following permissions:
• Import bot and Manage package feature permissions
• Check in folder permission

 

Importing Enterprise 11 bots when migrating to Automation 360

You can import your Enterprise 11 bots from the Enterprise 11 Control Room instance to Automation 360.
This method enables you to consolidate the Enterprise 11 bots from multiple Control Room repositories
to a single Automation 360 repository. After importing the bots to Automation 360, use the Bot Migration
Wizard to convert the bots to the Automation 360 supported format (.bot).

Modes to import and export bots

You can use one of the following two modes to import and export bots across different Control Room
instances. Choose a method that best suits your environment and requirements.

Modalità Manuale Involves exporting and importing bots using the
user interface.
Esporta bots alla pagina 2835 | Importa bots alla
pagina 2837

Automated mode Involves exporting and importing bots using Control
Room APIs.
BLM API

Moving a bot

To move a bot from one environment to another, follow these steps:
1. Export the bot from the Control Room in the source environment.
2. Import the bot into the Control Room in the destination environment.

Linee guida per l'esportazione e l'importazione di bots
Leggi le linee guida prima di esportare o importare bots.

Linee guida per l'esportazione di bots

• Esporta i pacchetti di azioni insieme al bot perché i pacchetti nella Control Room di destinazione in cui si
sta importando il bot potrebbero essere diversi.

• Esporta i bots in cartelle in modo intelligente spostando tutti i bots da una cartella prima di passare alla
cartella successiva. Quindi non selezionare bots da cartelle diverse
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• Assicurati che il server SMTP (e-mail) sia integrato con la Control Room in modo da poter ricevere un
collegamento al pacchetto esportato tramite e-mail.
Impostazioni del server di posta elettronica alla pagina 1502

• Assicurati che le Control Room di origine e destinazione abbiano lo stesso set di valori globali.
• Assicurati che le Control Room di origine e di destinazione abbiano lo stesso set di armadietti e

credenziali indicati nei bots.

Linee guida per l'importazione di bots

• Azione consigliata: When importing bot from the Automation page, use the Skip the bot or file
(don't import it) option because you might want to check the bot first before overwriting it with the
imported bot.

• Consigliato: Per prima cosa importa i bots nel tuo archivio privato (se si è sviluppatori di bot), verifica
il bot, quindi archivialo nell'area di lavoro pubblica.

• Il percorso della directory bot è sensibile alla distinzione tra maiuscole e minuscole, quindi assicurati
che i percorsi di esportazione e importazione utilizzino lo stesso tipo di maiuscole e minuscole in Control
Room.

• Before importing a bot file of size 200 MB or more, check your load balancer configuration. In few
environments, the bot import might fail with an error.

Esporta bots
You can export a bot from one Control Room to another.
• È possibile esportare solo bots presenti nello spazio di lavoro pubblico. Per esportare i bots, seleziona i

bots nello spazio di lavoro pubblico prima di esportarli nello spazio di lavoro privato.
• Ensure that you have the View package permissions.
• Ensure that you have the View content rights at the folder level from which you want to export the

bots.
• Assicurati che la versione di Control Room e i pacchetti nella Control Room sorgente e di destinazione

siano gli stessi sia per l'esportazione che per l'importazione.

Leggi le linee guida prima di esportare i bots.
Linee guida per l'esportazione e l'importazione di bots alla pagina 2834

Recommendation:  To efficiently use the Control Room disk size, as a Control Room administrator, delete
the old export packages from C:\ProgramData\AutomationAnywhere\Server Files\BLM on the
Control Room machine.

1. Nel pannello di sinistra, fai clic su Automazione.
Viene visualizzato un elenco dei moduli e dei  disponibili.

2. Click Export bots icon in the public workspace.
3. Select the bot you want to export.

• Versione più aggiornata: Fai clic sulla scheda Versione più aggiornata per selezionare la versione
più aggiornata del bot.

• Versione con etichetta: Fai clic sulla Versione di produzione per selezionare la versione con
etichetta del bot.
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4. Fai clic su Avanti.
Il bot e le relative dipendenze sono pronti per l'esportazione e visualizzati nella finestra Esamina
dipendenze. Se l'opzione etichetta di produzione è selezionata per il bot padre, vengono selezionati
automaticamente anche i corrispondenti bots dipendenti con l'etichetta di produzione. Se uno qualsiasi
dei bots dipendenti non ha l'etichetta di produzione applicata, viene selezionata la versione più
aggiornata del bot.

5. Fai clic su Avanti.
All related packages are displayed.

6. Select the necessary packages associated with the bot to export.
Seleziona Escludi pacchetti bot per rimuovere tutti i packages dall'esportazione.

7. Opzionale: Enter a password in the Create password field.
Password enhances the security for your bot or file when exporting from one Control Room to another.

8. Re-enter the password in the Confirm password field.
9. Fai clic su Esporta bot e file.

Tutti i bots selezionati vengono esportati in un file zip.
Based on the result (failure or success) of the export bot functionality, a notification is also displayed
in the Control Room Notifications icon. For more information, see Esporta bot alla pagina 2925 event
notification.

Nota:  Se disponi di bots di analisi nella tua Control Room, anche tutti i dashboard Bot Insight
(predefinito, personalizzato e pubblicato) associati ai bots vengono esportati nel file zip.

If you have configured SMTP, an email is sent that contains a link to the zip file of the exported
package.
If you have not configured SMTP, perform the following steps to access the link to the zip file of the
exported package:
a) Navigate to Activity > Historical.
b) Search and view the historical activity of the exported package.
c) Fai clic su Scarica file zip esportato.

A link to download the zip file is displayed.

10. Use the link to download the zip file and save it to a location for importing it to another Control Room.

Nota:  If you are exporting a large size bot or dependency, there might be a delay in the download of
the export zip file from the Activity > Historical page.

Import the bots into an Control Room.
Attività correlate
Importa bots alla pagina 2837
Puoi importare bots con le relative dipendenze da una Control Room all'altra. L'ambiente di origine può
essere Automation 360 Control Room, Enterprise 11, or Enterprise 10Istanza Control Room.
Riferimenti correlati
System roles alla pagina 2709
System roles are preconfigured with the permissions necessary to perform the tasks within the scope of
that role. They cannot be modified or deleted. Administrators assign the roles to users to enable them to
access features and perform operations in the Control Room.
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Importa bots
Puoi importare bots con le relative dipendenze da una Control Room all'altra. L'ambiente di origine può
essere Automation 360 Control Room, Enterprise 11, or Enterprise 10Istanza Control Room.
• Assicurati che i seguenti diritti per l'importazione di bots siano abilitati:

• Autorizzazione all'importazione di bots
• Crea autorizzazione cartella, se necessario
• Autorizza all'archiviazione in area di lavoro pubblica, se stai importando in area di lavoro pubblica

• Assicurati che la versione di Control Room e i pacchetti nella Control Room sorgente e di destinazione
siano gli stessi sia per l'esportazione che per l'importazione.

• Devi disporre di una licenza Bot Creator per importare bots nell'area di lavoro privata o pubblica.
Puoi importare bots nell'area di lavoro pubblica, se disponi delle autorizzazioni necessarie,
indipendentemente dalla licenza.

• Per importare bots Enterprise 11 nella tua Control Room Automation 360, prendi in considerazione i
seguenti requisiti aggiuntivi:
• You must have the required aapkg package that you created using the Bot Lifecycle Management

export feature in the Enterprise 11 Control Room instance.
• Il pacchetto aapkg deve essere presente nello stesso computer Automation 360 in cui desideri

importare i bots Enterprise 11.
• You can import the password protected aapkg packages using the Bot Lifecycle Management

Import API only. See Import repository bots in BLM API

• Leggi le linee guida prima di importare i bots.
Linee guida per l'esportazione e l'importazione di bots alla pagina 2834

• To import bots from one Control Room to another, use the exported zip file (or aapkg file, in case
of Enterprise 11 or Enterprise 10). Se SMTP è configurato, riceverai un link per scaricare il file zip o
aapkg all'indirizzo e-mail configurato. Se SMTP non è configurato, puoi accedere al collegamento di
download accedendo alla pagina Attività > Cronologia.

Nota:  Puoi importare bots Enterprise 11 (file .aapkg) con o senza MetaBots dipendenti solo nell'area
di lavoro pubblica. Se importi il file nell'area di lavoro privata, assicurati che le dipendenze MetaBots
dipendenti siano incluse.

1. Nel pannello di sinistra, fai clic su Automazione.
Viene visualizzato un elenco dei moduli e dei  disponibili.

2. Fai clic su Importa bot.
3. Sfoglia e seleziona il file zip o aapkg richiesto in base all'ambiente di origine:

Ambiente di origine Azione

Automation 360 bots Seleziona il file zip richiesto.

Enterprise 11 or Enterprise 10bots Seleziona il file aapkg richiesto.

© 2023 Automation Anywhere. All rights reserved.     2837

blm-api.html


    Automation Anywhere - Gestisci

4. Seleziona l'area di lavoro privata o pubblica in base al seguente ambiente di origine:
Ambiente di origine Azione

Automation 360 bots Puoi selezionare l'area di lavoro privata o pubblica
in base alle esigenze.
Se disponi di bots di analisi nell'ambiente
Automation 360 di origine, anche tutti i
dashboard Bot Insight associati vengono
importati in base alla seguente selezione:
• Selezionando l'area di lavoro privata, puoi

visualizzare solo dashboard predefiniti e
personalizzati.
Per visualizzare i dashboard pubblicati,
devi archiviare i bots nello spazio di lavoro
pubblico.

• Selezionando l'area di lavoro pubblica, puoi
visualizzare solo i dashboard pubblicati.
Per visualizzare i dashboard predefiniti e
personalizzati, devi estrarre i bots nell'area di
lavoro privata.

Enterprise 11 or Enterprise 10bots Seleziona lo spazio di lavoro pubblico.
This selection enables you to migrate Enterprise
11 or Enterprise 10bots to the Automation 360
environment later during migration.

5. Opzionale: Immetti la password nel campo Password.
Se il bot o il file esportati sono protetti da password, verrà richiesto di inserire una password. Ottieni la
password dall'utente che ha esportato il bot o il file.

6. Se alcuni dei file importati dal pacchetto sono già disponibili in Control Room, seleziona una delle
opzioni seguenti:
• Salta il bot o il file (non importarlo)
• Sovrascrivi il bot o il file con quello importato

7. Fai clic sull'opzione Importa bot.
8. Una volta completata l'importazione, in base all'ambiente di origine, accedi all'archivio corrispondente

per trovare e utilizzare il bot importato:
Ambiente di origine Azione

Automation 360 bots Accedi all'area di lavoro corrispondente (privata
o pubblica, in base alla selezione effettuata nel
passaggio 4).
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Ambiente di origine Azione

Enterprise 11 or Enterprise 10bots Passa allo spazio di lavoro pubblico nella
cartella Bot > Le mie attività o Bot > I miei
metabot.

Nota:  Enterprise 11 and Enterprise 10I
bots vengono importati in formato .atmx e
.mbot. Use the migration wizard to convert the
Enterprise 11 and Enterprise 10bots files to the
.bot format, which is supported in Automation
360.
Migrazione dei bots di Enterprise alla pagina 1216

Attività correlate
Esporta bots alla pagina 2835
You can export a bot from one Control Room to another.
Riferimenti correlati
System roles alla pagina 2709
System roles are preconfigured with the permissions necessary to perform the tasks within the scope of
that role. They cannot be modified or deleted. Administrators assign the roles to users to enable them to
access features and perform operations in the Control Room.

Credentials and lockers in the Credential Vault
L'Credential Vault archivia in modo sicuro informazioni sensibili come password, numeri di account e
numeri di previdenza sociale nelle credenziali e in lockers per l'utilizzo nelle attività di automazione. It
facilitates role-based access for users of a Control Room and ensures that sensitive values are not stored in
bots or on devices.
The Credential Vault consists of two main features: credentials and lockers.
Procedure consigliate:
• Ogni credenziale dovrebbe contenere una singola password utilizzata per l'autenticazione a un sistema

specifico.
• La credenziale può avere attributi aggiuntivi come il nome utente o l'hostname, a seconda di ciò che è

richiesto nel processo di autenticazione per il quale la credenziale viene utilizzata.
• Le credenziali per le applicazioni che trattano i dati che richiedono la massima riservatezza hanno il

minor numero di consumatori, mentre le credenziali per le applicazioni che richiedono una minore
riservatezza possono avere un numero maggiore di consumatori. Segregare le credenziali in base alle
applicazioni e alla riservatezza dei dati.

• Gli armadietti sono creati per conservare le credenziali legate a uno scopo aziendale specifico o a una
classe di applicazione basata sulla riservatezza.

Credenziali La credenziale contiene le informazioni sensibili
negli attributi. An attribute can have a value that
is standard for all users or it can accept a user-
input value. For example, an Email credential
can hold three attributes: host name (standard
value), username (user input), and password
(user input).
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Per impostazione predefinita, tutti gli utenti possono
creare, gestire e utilizzare le loro credenziali. A
user is granted access to another user's credentials
by receiving access to a locker that holds the
credential. Se la credenziale richiede un valore
immesso dall'utente, viene visualizzata nella scheda
RICHIESTE DI CREDENZIALI.
Una credenziale deve essere assegnata a un locker
per essere utilizzata per la creazione e l'esecuzione
di un bot.

Armadietti Un armadietto specifica quali utenti possono
visualizzare, modificare o accedere alle credenziali.
For example, a human resources (HR) locker can
hold Email, Database, and Training website
credentials and allow only specific employees of the
HR department to use the credentials in their bots.
A user with either the AAE_Locker Admin role
or a user-created role with the Manage my
credentials and lockers permission configures
lockers, adds credentials, and grants access to
other users.

Benefits of using the Credential Vault

Apart from providing a secure and centralized location for storing credentials, using the Credential Vault
also:
• Minimizes credential fraud.
• Provides an environment to enable improved security.
• Enables businesses to adhere to the processes and credential management compliance standards.
• Offers increased automation opportunities with secure data applications.

Concetti correlati
RBAC for Credential Vault credentials management alla pagina 32
Credentials created in the Control Room are used across Bot Creators and Bot Runners.
Configure Credential Vault Connection mode alla pagina 2740
Credential Vault is a centralized location for securely storing credential information used by bots.

Set up lockers and credentials in Credential Vault
Assign credentials to lockers for Bot Creators to access during the bot building process.
Ensure that you are logged in to the  as the administrator.
The credentials assigned are typically those where the administrator is granting some internal, business-
related access to a Bot Creator or Bot Runner for RPA development, for example to a Salesforce account.

Nota:  Credential and attribute names are not case-sensitive and are stored as "lower-case".

1. Navigate to Manage > Credentials.
2. Click Create credential.
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3. Enter the Credential name and a Description for the configured credential or select External key
vault.
If integrating with an external key vault, then proceed to Select External key vault.

4. Enter the Attribute name and supply the Description for the attribute.
5. Select one of the following Input options:

Inserisci Valore

Standard Enter the value. All users see the same credential
value set by the credential owner.

Fornito dall’utente The value field is not available because the
values are not preset during creation. Only
users of the locker containing this credential can
provide the value.

6. Set Security for the attribute.

Nota:  When the Masked option is selected, the attribute value is marked as a password-only
attribute and shown as asterisk (*) characters for security purpose.

7. Click Create credential.
8. Click the MY LOCKERS tab.
9. Click Create locker.
10. Inserisci il Nome.
11. Opzionale: Immetti una descrizione.
12. Click Create locker.

Set up locker and assign credentials
Create a role, credentials, and locker to share related sensitive values with a group of users, so they can
use those values to build or run bots.
Do the following to set up the locker and assign credentials:
1. Create a role alla pagina 2693

Define a role and assign permissions to access various features for building bots.

Nota:  You must have the AAE_Admin role or the Manage roles permission to create a role and
assign it to users.

2. Crea credenziali alla pagina 2842
Create a credential and add the required attributes.

Nota:  You must have the Manage my credentials and lockers and Create standard attributes
for a credential permission to create a credential and attributes.

3. Crea locker alla pagina 2844
Create a locker to group similar credentials and share with other users.

Nota:  You must have the AAE_Locker Admin role or the Manage my credentials and lockers
permission to create a locker and assign users and roles to it.

Concetti correlati
RBAC for Credential Vault credentials management alla pagina 32
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Credentials created in the Control Room are used across Bot Creators and Bot Runners.
Attività correlate
Edit a credential alla pagina 2843
Modify credential details and add or remove attributes.
Edit a locker alla pagina 2845
Add or remove credentials, owners, managers, participants, or consumer roles.

Crea credenziali
Create a credential and add the required attributes.
This task is performed by the Automation Anywhere Control Room administrator. You must have the
necessary rights and permissions to complete this task. Ensure you are logged in to the Control Room
as the administrator, or a user with either the AAE_Locker Admin role, or a user-created role with the
Manage my credentials and lockers permission to configure lockers, add credentials, and grants
access to other users.
Assign the credential when adding the credential details. If no locker was created, create a locker and then
assign the credential. Add up to 50 attributes to a credential.
1. Log in to the Control Room as the administrator.
2. Navigate to Manage > Credentials and click Create credential.
3. Enter the Credential name and a Description for the configured credential or select External key

vault.
If integrating with an external key vault, then proceed to Select External key vault.

4. Enter the Attribute name and supply the Description for the attribute.
5. Select External key vault.

If integrating with an external key vault, such as AWS, Microsoft Azure, or CyberArk, enter the
required credentials for the specified external vault as follows:

AWS Enter the secret name.
CyberArk Enter the object name.
Microsoft Azure Enter the secret name.

6. Select one of the following Input options:
Inserisci Valore

Standard Enter the value. All users see the same credential
value set by the credential owner.

Fornito dall’utente The value field is not available because the
values are not preset during creation. Only
users of the locker containing this credential can
provide the value.

7. Set Security for the attribute.

Nota:  When the Masked option is selected, the attribute value is marked as a password-only
attribute and shown as asterisk (*) characters for security purpose.
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8. Opzionale: Select Use attribute ONLY on Password or Masked fields.
This option ensures that bots input the attribute value only into fields that are identified as password
fields.

Nota:  When this option is selected, an attribute is available only for the commands in Automation
Anywhere Enterprise client that support credential variables and where the fields are of Password
type.

9. Click Create credential.

Assign this credential to a locker.

Edit a credential
Modify credential details and add or remove attributes.
A credential can be edited by the owner when the credential is not assigned to a locker. If a credential
input type is user-provided, then locker consumers can edit the credential to input a value.
Role-based access and locker permissions

Nota:  A user with the AAE_Locker Admin role can assign a credential to a new owner. Per ulteriori
informazioni, consulta Trasferisci proprietà credenziali… alla pagina 2843.

1. Navigate to Manage > Credentials.
2. Hover over the Actions icon for the credential.
3. Click the Edit icon. ( )
4. Edit the credential.

If the email notification setting is enabled and credentials are added to a locker, then all the locker
consumers receive an email.
The maximum limit of credential attributes that is allowed is 50. If you have upgraded to the current
version and have migrated credentials that have more than 50 attributes, when editing that particular
credential, the following message displays: Credentials can only have a maximum of 50
 attributes. To continue, remove the additional attributes that cannot be saved and add those to a
new credential.

5. Fai clic su Salva modifiche.

Riferimenti correlati
Credential Vault email notifications alla pagina 2846
When the email notification setting is enabled, it ensures that users are notified of any changes to
credentials and lockers.

Trasferisci proprietà credenziali…
A user with the AAE_Locker Admin role can transfer a credential to a different owner.
Una credenziale può essere riassegnata a un proprietario diverso solo se si trova in un locker. Il nuovo
proprietario può essere il proprietario, il manager o il partecipante dell'locker.
1. Navigate to Manage > Credentials.
2. Utilizza la barra di ricerca per trovare le credenziali.
3. Passa con il mouse sopra i puntini di sospensione verticali a destra della credenziale.

Viene visualizzato il menu Azioni.
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4. Fai clic su Trasferisci proprietà credenziali.
Viene visualizzato un elenco di utenti con accesso a locker,

5. Seleziona il nuovo proprietario delle credenziali.
6. Fai clic su Sì, invia.

Crea locker
Create a locker to group similar credentials to share with other users.
You must either have the AAE_Locker Admin role or Manage my credentials and lockers permission
and the necessary permission to View Users and Roles.

Nota:  You must have the View Users and Roles basic information permission to view information about
other users to add them as locker owners/Managers/participants. Without this permission, an "Access
denied" error will occur.

Vedi RBAC for Credential Vault credentials management alla pagina 32
There is no limit on the number of credentials that can be stored in a locker. A credential can only belong
to one locker. Consulta Crea credenziali alla pagina 2842. Credentials are further divided in logical groups
called lockers.
To create a locker, follow these steps:
1. Navigate to Manage > Credentials, and then click the Lockers tab.
2. Click Create locker.
3. Inserisci il Nome.
4. Opzionale: Immetti una descrizione.
5. Select the Credentials to add to the locker or select External key vault.
6. Enter External key vault credentials.

If integrating with an external key vault, such as AWS, Azure, or CyberArk, enter the required
credentials for the specified external locker:

AWS Enter the prefix of secrets stored in the locker.
CyberArk Enter the safe name where the credential lockers

are stored.
Azure Enter the prefix stored in the locker.

7. Fai clic su Avanti.
8. Add the Owners.

A locker must have at least one owner. The locker owner can edit, view, and delete a locker and also
add or remove other owners.

9. Fai clic su Avanti.
10. Opzionale: Add the Managers and click Next.

The locker manager can view, edit and delete the locker, and add participants but cannot add owners
or managers to the locker.

11. Opzionale: Add the Participants and click Next.
A locker participant has access to view a locker and add their own credentials to a locker.

Nota:  A locker participant does not have access to or visibility of credentials created by other
users.
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12. Add the Consumers.
Select one or more roles. Users with these roles have access to the locker. System-created roles are
not shown in the Consumers list.
Tipo Autorizzazione

Standard Locker consumers can view the locker and all the
credentials inside the locker. All consumers see
the same credential value set by the credential
owner.

Fornito dall’utente Locker consumers can input their information
in user-provided credentials with user-provided
attributes.

13. Click Create locker.

If the email notification setting is enabled, users receive an email confirming the locker name and their
permissions to that locker.

Edit a locker
Add or remove credentials, owners, managers, participants, or consumer roles.

Only a locker owner, locker manager, or locker admin can edit a locker. To edit a locker, follow the steps
mentioned below:

Nota:  Credential, owner, managers, participants, and consumers are separate entities associated with
the locker to grant permission. These are not locker entity attributes and modifying these does not change
locker objects. Therefore when you edit these fields inside a locker, the locker object is not modified and
thereby locker's last modified field is also not updated.

1. Navigate to Manage > Credentials, and then click the Lockers tab.
2. Hover over the Actions icon for the locker.
3. Click the Edit icon. ( )
4. You can make changes to the following:

Opzione Descrizione

Credenziali Add or remove credentials that are assigned to a
locker.

Proprietari Add or remove locker owners.

Nota:  A locker must have at least one owner.

Gestori Add or remove locker managers.

Partecipanti Add or remove locker participants.

Consumatori Add or remove locker consumers.

If email notification setting is enabled and credentials are added to a locker, then all the locker
consumers will receive an email.

5. Fai clic su Salva modifiche.
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Credential Vault email notifications
When the email notification setting is enabled, it ensures that users are notified of any changes to
credentials and lockers.

Panoramica

Email notifications are sent for the following scenarios:

Credential is added to a locker When credential is added to a locker, a notification
is sent to all consumers of the locker to their email
address registered in the Control Room. The email
consists of a link to the credential that is added to
the locker. The consumers are redirected to edit the
credential page wherein they input the credential
value.

Member is added or removed from a locker An email notification is sent when a new member
(co-owner or participant) is added to a locker
or removed from the locker as a member of
participant.

Change in permission for locker members When a locker owner/admin grants or removes
locker membership permissions from a locker, an
email notification is sent to the locker members at
their email address. This ensures that members are
notified of their membership changes within the
locker.

Locker consumer gets added or removed from
a role assigned to a locker, or consumer role
gets added or removed from a locker

When a role assigned to a locker is modified by
addition or removal of users, an email notification
is sent to the new or existing user at their email
address so that the consumers are notified that
credentials are pending for their input in the locker.
Also when a new role added to a locker or an
existing role is revoked from the locker, an email
notification is sent to the new or existing consumers
at their email address so that the consumers are
made aware of the changes.

External key vaults for Automation 360
External key vaults provide a secure, encrypted storage space for sensitive data used by RPA. Customers'
sensitive data can be accessed and used by their RPA platform by storing the data in a corporate-approved
key vault, such as CyberArk Password Vault, AWS Secrets Manager, or Azure Key Vault.
Automation Anywhere provides a secure key vault called Credential Vault. Requirements for external
key vault usage are generally related to certain compliance standards and corporate security policies
implemented by your IT and IT security groups. As part of their data security policies, these groups select
and maintain corporate key vault services, and define the standards for the protection of sensitive data.
The Automation 360 Control Room leverages external key vaults to store credentials for security and
compliance.

Nota:  External key vault integration is not supported on Oracle Database.
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Utenti e ruoli

The following users typically configure and work with external key vaults:

RPA Administrators RPA Administrators who have AAE_Admin and
AAE_Locker_Admin roles with permissions to
administer Automation 360 Control Room and
Credential Vault instances. The RPA Admin works
with the customer External Key Vault Admin.

Customer External Key Vault Administrators Customer External Key Vault Administrators who are
responsible for the administration and management
of the external key vault tasks (for example, setting
up, managing, and creating access policies).

Vantaggi

The Automation Anywhere Credential Vault is secure and provides deep integration with the RPA platform.
However, because corporate IT must provide secure data services as part of their IT security policies, the
RPA platform might be required to use external key vault technology to comply with corporate standards.
External key vaults enable the RPA platform to fully comply with corporate requirements and can provide
these additional benefits:
• Deep integration with the Identity Provider (IdP) and corporate authentication platforms such as single

sign-on (SSO) and Directory Services (such as Microsoft Active Directory).
• Support of password rotation and synchronization with the systems used with the RPA platform.
• Administration of the key vault and security best practices are performed by the IT group who manages

the external key vault instead of the RPA administrators. As a result, the RPA platform becomes a
consumer of the credential service.

Guidelines

External key vault integration guidelines support the operation of the RPA platform relating to the
coordination, configuration, and consumption of credentials and sensitive data from the external key vault
technology.
• Coordination: Establish designated contacts for the key vault and RPA platform technologies and

identify the individuals responsible for communicating operational guidelines, security policy, and
compliance requirements for credential management.

• Configuration: Designated contacts collaborate on the use case implementation and configuration
requirements of the RPA platform and the external key vault.

• Consumption: Based on which use cases are implemented, designated contacts monitor the
integration of the RPA platform and the external key vault and coordinate credential rotation and
naming requirements.

Integrating external key vault with Control Room
Automation Anywhere Control Room supports these external key vaults: CyberArk Password Vault, AWS
Secrets Manager, and Azure Key Vault.
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Use cases

The following use cases are supported:

Control Room bootstrap Retrieval of credentials used by the Control Room
to authenticate to supporting services such as
database and Control Room software service
account.

Control Room system Retrieval of credentials used by the Control
Room for Active Directory (AD) and email (SMTP)
integration.

Agent auto-login Retrieval of credentials used by the RPA platform to
launch automations on designated Automation 360
Bot Agent devices.

Agent automation Retrieval of credentials that the automation (bot)
uses during runtime to perform authentications to
the applications that are being automated.

Plan your integration

Before you integrate your external key vault with the Automation 360 Control Room, you need to develop
an overall external key vault strategy.
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The answers to these questions will help determine the integration requirements for the external key vault.

What type of Automation 360 Control Room
deployment do you have: On-Premises or
Cloud?

• On-Premises: The Control Room and external
key vault are hosted at the customer's site and
environment.

The external key vaults might contain these
external key vaults hosted within the customer
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site (customer-controlled datacenter or
environment):
• CyberArk Password Vault – Customer On-

Premises environment
• AWS Secrets Manager – Customer AWS

environment
• Azure Key Vault – Customer Azure

environment

You can configure the external key vault
connection during initial installation or post-
installation using the key vault utility.

• Cloud: The Control Room is hosted on the
Automation 360 Cloud environment and the
external key vault is hosted within the customer
site (where the customer-controlled datacenter
is either On-Premises or in a Cloud environment
such as AWS):

The key vault in the customer network requires
connection to the Automation 360 Cloud Control
Room. You configure the connection to the
external key vault from the Automation 360
user interface. Customer network perimeter
configuration is required.

What type of third-party external key vault
do you have?

CyberArk Password Vault, AWS Secret Manager, or
Azure Key Vault.
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Each external key vault has their own specific
requirements. Review all configuration requirements
with RPA and external key vault administrators
before starting the integration.

What type of credentials do you need to
retrieve from the external key vault based on
the supported use cases?

By integrating the Automation 360 Control Room
with your external key vault, you can retrieve
credentials that support these use cases:
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Coordinate with external key vault admin team

To ensure a productive, efficient, and rapid integration with the external key vault, you must coordinate
with the external key vault administration team and exchange the technical requirements of the RPA
platform. By carefully planning and coordinating with the external key vault administration team, you can
quickly integrate the Automation Anywhere Control Room with the external key vault and avoid time-
consuming troubleshooting issues.
We suggest you follow these guidelines to structure your integration process:
• Review the supported credential use cases to determine which credentials the RPA platform requires to

retrieve from the external key vault.
• Schedule a kick-off meeting with the external key vault administration team to exchange information for

these details:
• Which key vault to use?
• Which use cases to configure?
• What are the credential naming conventions required by the RPA platform?
• How are the credentials configured and updated on the external key vault?
• Does the external key vault have multiple instances (multiple instances of the external key vault can

be used for different Automation Anywhere Control Room instances)?
• Who are the designated contacts for the RPA platform and key vault administration?
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• Review the configuration requirements for the Control Room:
• Are you installing a new Control Room with key vault integration?

If so, then review the installation procedure for the external key vault integration.
• Are you configuring an existing Control Room to use external key vault integration for the first time?

If so, then review the key vault utility usage procedure to configure key vault integration post-
installation.

• Is the Control Room an Automation 360 Cloud Control Room that will connect to an on-premises key
vault?
If so, then you must coordinate with your IT networking team to configure connectivity between the
Cloud Control Room and your internal network.

• Review the external key vault configuration procedure and note all integration settings requirements:
• Key vault configuration requirements to configure on the external key vault before integration
• Control Room operating system configuration
• Authentication method that the Control Room will use to connect to the external key vault

• Schedule integration meetings to coordinate these configuration and set up tasks for the Control Room
and external key vault administrators:
• Configuration of the key vault connection
• Configuration of each use case
• Testing of each use case

Nota:  These integration meetings should be ongoing until you have configured and tested all use
cases.

• Add the external key vault integration to regular IT cadence meetings to monitor the operation of the
Control Room and the external key vault, specifically credential rotation coordination.

External key vault naming conventions
Specific authentication credentials and external key vaults have restrictions on the use of certain characters
in usernames, phrases, and other text. Also, there are different naming conventions to follow based on the
external key vault and the credential use cases: Agent auto-login or Agent automation.

Agent auto-login naming conventions

• CyberArk: All Agent auto-login credentials are retrieved from the specified safe name and assumed to
exist within the Auto-login Credential Safe.

• AWS Secrets Manager and Azure Key Vault: All Agent auto-login credentials must adhere to the
required naming conventions detailed on this page.

If the Control Room performs an auto-login credential retrieval but no credential exists in the Auto-
login Credential Safe that matches that user name, then the auto-login will fail. For any unattended
automations, all robotic or digital worker user IDs must have an auto-login credential configured for each
Control Room user within the external key vault.
The Control Room retrieves auto-login credentials based on the object naming convention within the
external key vault. The Control Room searches for an object where the object name (the credential name
in the external key vault) matches the Control Room username for which it is performing auto-login.
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The prefix autologin_ is required as part of the naming convention for auto-login credentials for all
external key vaults: CyberArk, AWS, and Azure. The name of the auto-login credential in the external key
vault must contain autologin_ followed by the Control Room username. In some cases, certain key
vaults have restrictions on the characters that can be used in credential object names. Additionally, to
support how different use cases encode credentials, Automation 360 requires that certain characters be
reserved or encoded.
The following table lists examples of the object naming conventions expected in the Control Room:

Control Room username Expected object name format

ABCD\user123 autologin_ABCD--user123

user123@rpa.abcd.com autologin_user123-40-rpa-2e-abcd-2e-com

Nota:  For On-Premises customers using AD authentication, you must format auto-login usernames using
the UPN format or domain\username postfix.

For auto-login credentials, keep these in mind:
• The object name in the external key vault must contain autologin_ as a prefix.
• The auto-login credential names must map to the Control Room username (login ID) for the credential

being retrieved.
Some external key vaults have usage restrictions of certain characters, such as backslash (\) and
ampersand (@) in the secret name (object name), and restrictions on how special characters are
interpreted within API calls. If the user ID contains special characters, then you must encode the secret
name (object name) in the external key vault using ASCII code character substitutions, as listed in the
following table.

This character Changes to this ASCII code character
substitution

\ (backslash) --

- (dash) -2d-

_ (underscore) -5f-

@ (ampersand) -40-

. (period) -2e-

Nota:  Except for the backslash being mapped to double dashes, the dash, period, underscore, and
ampersand are mapped using their ASCII code bracketed in dashes.

Agent automation naming conventions

Agent automation credentials are credentials retrieved by the automation during runtime and used by the
automation bot to authenticate with applications. Automation credentials retrieved from external key vaults
are mapped in the Automation Anywhere Credential Vault using the External Key Vault option when
configuring lockers and credentials.
The Automation Anywhere locker is mapped to either of the following:
• Safe Name (CyberArk)
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• Secret Name Prefix (AWS and Azure)

A credential is mapped to either of the following:
• An Object Name (CyberArk)
• A Secret Name body (AWS and Azure)

Nota:  You can map any Automation Anywhere locker to any CyberArk Safe Name. The Safe Names used
to map Automation Credentials should be distinct from the Safe Name used for auto-login.

To support the Automation Anywhere user-defined credentials functionality, you can create credentials
using a Control Room_username postfix because these credentials are retrieved based on the user context
of the running bot. If you do not create user-defined credentials, then the automation bot credential
retrieval process retrieves the system credential.

Nota:  For On-Premises customers using AD authentication, you must format Agent automation
usernames using the UPN format or domain\username postfix.

External key vaults prohibit different special characters in secret names. As a result, you must encode
some characters in the credential (secret) name in the external key vault based the type of external key
vault (CyberArk, AWS, or Azure) you are using and its specific requirements.

CyberArk Password Vault automation example

The following table shows CyberArk external key vault examples using naming conventions for automation.

Nota:  The Safe Name maps to the locker for the Control Room, and the Object Name maps to the
credential for the Control Room.

Automation credential
example

Safe Name Object in locker Control Room username

System credential in locker
mapped to Safe Name

finance glaccess None - system credential

User-defined credential in
locker mapped to Safe Name

finance glaccess_ABCD--RPA--
user123

ABCD\RPA\user123

User-defined credential in
locker mapped to Safe Name
where username is encoded
with ASCII mapping

finance glaccess_ABCD--RPA-2e-
user123

ABCD\RPA.user123

AWS Secrets Manager automation example

The following table shows AWS Secrets Manager external key vault examples using naming conventions for
automation.

Nota:  The AWS Secret Name Prefix maps to the locker for the Control Room, and the AWS Secret Body
maps to the credential for the Control Room.
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Automation credential
example

AWS
Prefix

AWS
Secret
Body

Secret in AWS Control Room
username

accounting_pdf
System credential in locker
mapped to AWS Secret
Name prefix accounting

accounting pdf accounting_pdf
(system)

None - system
credential

accounting_pdf_ABCD--
user123
User-defined credential
in locker mapped to
AWS Secret Name prefix
accounting

accounting pdf accounting_pdf_ABCD--
user123

ABCD\user123

Azure Key Vault automation example

The following table shows Azure Key Vault external key vault examples using naming conventions for
automation.

Nota:  The Azure Prefix maps to the locker for the Control Room, and the Azure Secret Body maps to the
credential for the Control Room.

Automation
credential
example

Azure Prefix Azure Secret Body Secret in Azure Control Room
username

accounting_cv1
System credential
in locker mapped
to Azure Secret
name prefix
accounting

accounting cv1 pdf-5f-cv1
(system)

None - system
credential

accounting_cv1_ABCD
\user123
User-defined
credential in locker
mapped to Azure
prefix

accounting cv1 pdf-5f-cv1-5f-
ABCD--user123

ABCD\user123

When deploying Azure credentials, the Azure Key Vault character underscore (_) is a reserved character
and cannot be used in credential names. You must substitute any underscore (_) usage with the ASCII
code value 5f bracketed by dashes:

This character Changes to this ASCII code character
substitution

\ (slash) --
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This character Changes to this ASCII code character
substitution

- (dash) -2d-

_ (underscore) -5f-

@ (ampersand) -40-

. (period) -2e-

Integrating CyberArk Password Vault with Automation 360
You can integrate Automation 360 to retrieve credentials from the CyberArk Password Vault. The
credentials become resident within the CyberArk Password Vault where they are managed, rotated, and
synchronized.
You integrate the Automation 360Control Room by connecting it to the CyberArk Password Vault through
the CyberArk Central Credential Provider (CCP) APIs. No additional licensing is required to integrate with
the CyberArk Password Vault or use the CCP APIs.

Nota:  We recommend that you control access to the CyberArk Password Vault through an IP address.

You can integrate Automation 360 with the CyberArk Password Vault using either of these deployments:
• Cloud
• On-Premises

The following diagram shows an Automation 360 Cloud deployment where the Control Room is hosted on
AAI Cloud:
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For On-Premises deployments, you deploy the following:
• Control Room as software within your customer environment.
• Bot Agent within your customer environment where automations run and access customer applications.

Importante:  You can edit the external key vault connection settings through the user interface in Cloud
deployments only. External key vault settings in On-Premises deployments are only configurable during
installation or with the key vault utility post-installation.

CyberArk Password Vault integration requirements

• Install CyberArk Central Credential Provider alla pagina 2859
• Implement X.509 client certificate authentication method alla pagina 2859
• CyberArk Central Credential Provider API configuration requirements alla pagina 2861
• Review CyberArk Credential terminology and identifiers alla pagina 2862
• Define CyberArk application ID alla pagina 2863
• Provision accounts in CyberArk Password Vault alla pagina 2864
• Set up access to the application and password providers alla pagina 2864
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Install CyberArk Central Credential Provider

You must install and configure the CyberArk Central Credential Provider on the CyberArk server. Consulta
CyberArk Central Credential Provider installation.

Implement X.509 client certificate authentication method

An X.509 client certificate is a type of digital certificate used by client systems to make authenticated
requests to a remote server and uses the widely accepted international X.509 public key infrastructure
(PKI) standard to verify that a public key belongs to the user, computer, or service identity contained within
the certificate.
The Automation 360Control Room uses a client certificate as the authentication method when connecting
to the CyberArk CCP APIs.
This authentication method is highly secure and leverages the system's truststore to store the client
certificate, server certificate, and private key. The truststore is a certificate storage location provided by
the operating system's software and it contains the issuing Certificate Authority's (CA) certificate. You can
import individual server certificates into the truststore. However it is more efficient to import the issuing
Certificate Authority (CA) certificate.
The following image provides an overview of certificate-based authentication:
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1. The client (Automation 360 Control Room) sends a request to the CyberArk AIM server (protected
resource).

2. The server then responds by sending a certificate back to the client.
3. The Automation 360 Control Room verifies the certificate sent by the CyberArk AIM server by

validating it against the trusted server certification information stored in the public part of the Control
Room truststore.

4. After validating the information in the truststore, the Automation 360 Control Room resends the
certificate back to the CyberArk AIM server.

5. The CyberArk AIM server then validates the certificate sent by Automation 360 Control Room against
the trusted client certification information stored in the public part of the AIM server truststore
Because client certificates (those with their private key) are generally distributed in
password protected format, the certificate file (using .p12 format, such as: c:\PATH
\aaeCyberArkCertificate.p12) requires a passphrase.
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6. Both parties (client and server) gain access to the protected resources if the certificates pass
validation based on the following:
• The Control Room certificate must be trusted by the CyberArk AIM server
• The Control Room must trust the certificate on the CyberArk AIM server
• The Subject field in the certificate matches the calling system's Fully Qualified Domain Name (DNS

Name)
• The certificate has not expired

Importante:  As part of the integration planning phase, coordinate certificates and requests for
certificates. You will have to request that certificates be issued by the Public Key Infrastructure (PKI)
team before you can begin integration configuration. The certificate files are stored in the PKI folder
and accessed with the Control Room passphrase when required. The Control Room passphrase is stored
encrypted in the keyvault.properties file.

CyberArk Central Credential Provider API configuration requirements

You must have network connectivity between the Automation 360 Control Room and the CyberArk AIM
server. The Automation 360 Control Room is connected to the CyberArk Password Vault through the
CyberArk Central Credential Provider (CCP) APIs for both On-Premises or Cloud deployments.

Nota:  No additional licensing is required to use the CCP APIs.

To use the CCP API, you must set these required parameters:
• Automation 360 v.20 (supports bootstrap credentials with On-Premises deployment only)
• Automation 360 v.21 or later (supports all bootstrap and system use cases for On-Premises

deployments, auto-login, and automation credentials for both On-Premises and Cloud deployments)
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• The Control Room Key Vault contains these connection details:
• CCP API vault connection URL – For example: https://<host:port>/AIMWebService/api/

Accounts?
• CCP API AppID – You must configure the CyberArk AIM server with an Application ID (AppID). Ad

esempio: AACompanyControlRoom1.
Consulta Define CyberArk application ID alla pagina 2863.

• X.509 client certificate with private key issued to the Automation 360 Control Room
(The Control Room Fully Qualified Domain Name is in the Subject: field of the certificate)
and configured with the CyberArk AIM server for authentication. For example: c:\PATH
\aaeCyberArkCertificate.p12

Nota:  The .p12 format is required.

Review CyberArk Credential terminology and identifiers

CyberArk and Automation Anywhere use different terminology to describe and identify credentials:

Descrizione CyberArk Automation Anywhere

Where credentials are stored object credenziali

Primary partitioning of the key
vault

safe (contains objects) locker (contains credentials)

• Credentials in CyberArk are stored in objects, and each object is contained in a safe.
A single CyberArk instance can have multiple safes, where each safe has access controls for users.

• Credentials in Automation Anywhere are stored in lockers, where each locker has access controls for
Control Room users.

CyberArk identifies credentials by safe name AND object name. The CCP API uses a CyberArk safe name
and CyberArk object name to access credentials within the CyberArk Password Vault (the credential must
exist in CyberArk).
The following is a code sample CCP API call and corresponding response:

https://<host:port>/AIMWebService/api/Accounts?
AppID=BillingApp&Query=Safe=Billing;Object=MonthlyBilling

Risposta

{
       "Content":"",
       "PolicyID":"CyberArk",
       "CreationMethod":"PVWA",
       "Folder":"Root",
       "Address":"address tbd",
       "Name":"Application-CyberArk-address tbd-vb",
       "Safe":"aa_vb_safe",
       "DeviceType":"Application",
       "UserName":"vb",
       "PasswordChangeInProcess":"False"
}
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The credential value or secret (for example, the password) is stored in the Content attribute and the User
ID (the Control Room user name, for example vb) is stored in the UserName attribute.

Define CyberArk application ID

Automation 360 integrates with CyberArk Password Vault through the CyberArk Central Credential Provider
(CCP) API. The application ID (AppID) is a required configuration parameter.
As a CyberArk Administrator, use the CyberArk Password Vault Web Access (PVWA) interface to define the
application ID by following the specified procedure to prepare the CyberArk AIM server for integration with
the Control Room. Consulta CyberArk Password Vault Web Access.
1. You must log in as a user allowed to manage applications on the CyberArk platform (requires Manage

Users authorization).
2. From the Applications tab, click Add Application.
3. From the Add Application panel, enter the following information:

Opzione Azione

Nome Specify the unique name (ID) of the application.
We recommend using a name based on the Control Room name or
function, for example: AACompanyControlRoom1.

Descrizione Enter a short application description used to help identify it.

Business owner Enter contact information about the application's business owner.

Luogo Select the application location in the Vault hierarchy.
If a location is not selected, the application will be added in the
same location as the user who is creating this application.

4. Click Add to add the new application and display it on the Applications Details page.
5. From the Applications Details page, select the Allow extended authentication restrictions

check box to specify an unlimited number of machines and Windows domain OS users for a single
application.

6. From the Authentication tab, click Add to add details to the new application.
A list of available authentication characteristics are displayed, which the Credential Provider uses to
verify before retrieving the application password.

7. Facoltativo: Select OS user and enter the name of the user who will run the application, and then
click Add to add the OS user to the list of users in the Authentication tab.

8. Select Certificate Serial Number and enter the certificate serial number for the Control Room client
certificate, and then click Add.
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9. (Automation 360 recommended): From the Allowed Machines tab, click Add, and specify the IP/
host name/DNS address where the application is allowed to run and request passwords.
CyberArk AIM uses this address to ensure that only applications which run from specified machines
can access their passwords.

10. Click Add to add the IP address to the list of allowed machines.

Provision accounts in CyberArk Password Vault

Before an application can function, you must give the application access to existing user accounts or to
new user accounts to provision in the CyberArk Password Vault.
Use the Password Safe to provision the privileged user accounts required by the application. You can
provision accounts using one of these methods:
• Manually add accounts one at a time, and then specify all the account details.
• Automatically add multiple accounts using the Password Upload feature. To add account

automatically, you must have authorization to the Add accounts feature in the Password Safe.

For details about adding and managing privileged accounts, see Privileged Access Manager - Self-Hosted.

Set up access to the application and password providers

After the user accounts have been provisioned by CyberArk, you must set up access to both the application
and to CyberArk Application Password providers who are serving the application.
From where the Central Credential Provider is installed, add the provider user and application users as
members of the Password Safes (where the application passwords are stored). You can add the users
using one of these methods:
• Manually from the Safes tab
• By specifying the Safe names in the CSV file when adding multiple applications

To add users as safe members, from the Add Safe Member dialog box, add the provider as a safe
member with these access authorizations selected, and then click Add:
• Retrieve accounts (Access)
• List accounts (Access)
• View Safe Members (Monitor)
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Nota:  When installing multiple providers for the CyberArk Password Vault integration, we recommend
that you first create a group for them, and then add that group to the safe with the same selected access
authorizations.

To add application (AppID) as a safe member, perform these steps:
1. From the Add Safe Member dialog box, add the (AppID) as a safe member with Retrieve accounts

(Access) selected as the access authorization.
2. Fai clic su Aggiungi.

If the safe is configured for object level access, ensure that both the provider user and the application
have access to the passwords to retrieve. For details about adding and managing privileged accounts, see
Privileged Access Manager - Self-Hosted.

On-Premises integration using CyberArk Password Vault
As an Automation 360 administrator, you can configure the CyberArk On-Premises integration using one of
these methods: initial installation or post-installation using a command-line interactive key vault utility.
Within the On-Premises installation wizard, bootstrap credential retrieval from external key vault
configuration options are only available if you first configure the key vault connection. The configuration
options vary based on the external key vault you select.

Nota:  If you are using CyberArk in an Automation 360 Cloud deployment, then the CyberArk external
key vault must be reachable from the Cloud Control Room through the network perimeter firewall rules.
For external firewall rules configuration details, see Automation 360 IP addresses for external integrations alla
pagina 2757.

Choose your integration method:
• Initial installation
• Post-installation using key vault utility
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On-Premises initial installation using CyberArk Password Vault
Using the initial installation method, you can connect and configure the external key vault connector,
service account credential (Active Directory master password), and bootstrap (database) credential
identifier.

Nota:  You must select Microsoft SQL Server Authentication as the database; other database
authentication methods are not supported for this use case.

The initial installation supports a password-less installation regarding the Control Room bootstrap
credentials. The password-less installation identifies the bootstrap credentials by the Safe name and Object
name within CyberArk.
You can configure the SMTP and AD credential identifier to retrieve from the external key vault using the
Automation 360 user interface.
1. After you start the Automation 360 installation wizard, select On-premises as the Deployment

Option and click Next.
2. Accept the license agreement and click Next.
3. Select Custom as the Installation Type Preference and click Next.
4. Accept the default locations for the destination folders and click Next.
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5. To connect and configure the external key vault integration, select CyberArk.
a) In the Vault URL field, enter the CyberArk AIM server CCP API URL (for example: https://

<hostname:port_num>/.

Nota:  To access the CCP APIs, the Control Room will automatically append /AIMWebService/
api/Accounts? to the vault URL you enter. As a result, you must configure the Web Service on
the CyberArk AIM server as AIMWebService.

b) In the Application ID field, enter the CCP API AppID (for example: AAEControlRoom).
c) Enter the path to the CyberArk AIM server certificate (in .pem format using .p12) issued to

the Control Room server (The certificate Subject: field contains the Control Room fully qualified
domain name (FQDN)).
This certificate must be trusted by and configured within CyberArk.

d) Click Upload Certificate to store on the Automation 360 Control Room server.
e) Enter the certificate file passphrase used to access the Control Room certificate file.
f) Opzionale: If the issuing Certificate Authority (CA) of the CyberArk server certificate is not trusted

by the Control Room, then enter an optional server certificate.
This is the server certificate for the CyberArk server without a private key (the certificate Subject:
field contains the CyberArk AIM Server FQDN). The installer will add the optional CyberArk Server
certificate to the truststore used by the Control Room.

g) Fai clic su Avanti.

6. Accept the default settings from the TLS Configuration dialog box and click Next.
7. From the Service Credentials dialog box, select an option to specify the Safe name and Object

name from CyberArk instead of manually entering the user name and password for the Service
Account used by the Control Room.
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8. Click Service Account (retrieve credential from external key vault), and then enter the Safe
name and Object name values.
The installer will query CyberArk for the credential to validate that the object exists in the specified
safe.

Nota:  If the Service Account option to specify Safe name and Object name is not available, then
this indicates that the CyberArk Password Vault was not previously configured and connected properly
as the external key vault. Contact your AAI Support team or review.
Vedere anche: Troubleshooting external key vaults alla pagina 2911.

9. Fai clic su Avanti.
10. From the Database Server dialog box, select your Database Server and enter the name of your

Control Room database, and then click Next.

11. From the Database Authentication dialog box, select an option to specify the Safe name and
Object name from CyberArk instead of manually entering the user name and password the Control
Room uses to authenticate to the database.
a) Click SQL Server authentication (retrieve credential from external key vault), and then

enter the Safe name and Object name values.

Nota:  Enter the same Safe name you previously entered for the Service Account safe name.

b) Click Next to continue and complete the initial installation.

© 2023 Automation Anywhere. All rights reserved.     2868



    Automation Anywhere - Gestisci

After you successfully complete the initial installation, the Automation 360 Control Room can access and
retrieve credentials within the CyberArk Password Vault.

On-Premises post-installation using CyberArk Password Vault
You use the command-line interactive key vault utility during a scheduled system downtime and you
must stop all running Control Room services. You should coordinate any key vault configuration
changes that might impact connectivity parameters (such as App ID, vault URL, port numbers, and
certificate) during downtimes with the CyberArk administrative team.

Nota:  If you use the key vault utility to disable CyberArk Password Vault integration, you must first
unmap any mapped credentials that are in use.

Using the post-installation method, you can perform these actions:
• Modify or configure the external key vault connection parameters.
• (If not configured during initial installation) Modify or configure the service account credential (Active

Directory master password).
• (If not configured during initial installation) Modify or configure the database (bootstrap) credential

identifier (retrieved when authenticating the database).

Nota:  Retrieving bootstrap credentials from an external key vault might cause the Control Room to fail
if the external key vault is not accessible during boot-up, or if the external key vault is not accessible
when the Control Room refreshes database connections and authenticates users with Active Directory.

• Recover the Control Room for these reasons:
• By modifying the external key vault connection parameters, the service account, and database

credential safe and object identifiers.
• If CyberArk Password Vault connection parameters changes caused the Control Room to experience

connectivity issues.
• When credential identifiers for bootstrap passwords change.

You can address any initial configuration settings that were not set correctly and recover the system.

You can configure and edit SMTP and AD credential identifiers to retrieve information from the external
key vault from the Automation 360 Control Room by navigating to Administration > Settings > Active
Directory.
1. Run the key vault utility for the CyberArk Password Vault

Nota:  You must import the CyberArk server certificate (the certificate issued to the CyberArk server)
to the Java truststore before invoking the dB utility commands. The certificate can be in .cer (PEM)
format and does not contain a private key.

To run the key vault utility and update key vault connection settings:
a) As the Control Room administrator, access the Automation Anywhere Control Room installation

directory that was created during the initial Automation 360 installation.
Ad esempio: C:\Program Files\Automation Anywhere\Enterprise

b) Download the latest version of the key vault utility. To download the jar file used to update the
directory, open a browser and access the A-People site: A-People Downloads page (Login required).

Nota:  If DB authentication is configured to use external key vault, the utility returns the
following exception: Database currently configured to retrieve credentials
 from key vault. Update database authentication to WINDOWS/SQL to
 proceed further and exit.
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The utility requests the user to confirm the action: Disable/update of key vault might
 impact functionalities using key vault (for example, Active Directory
 configuration, Email Settings configuration). Make sure to update these
 settings (if any). Are you sure you want to continue?

c) Enter Y to continue.
d) Enter the following:

> jdk11\bin\java -jar certmgr.jar -appDir . -importTrustCert <Full path
 of the certificate>

e) Add these jvm arguments to the command to run the key vault utility:
1. -Djavax.net.ssl.trustStore="C:\Program Files\Automation Anywhere

\Enterprise\pki\trust\store.ks"

2. -Djavax.net.ssl.trustStorePassword=changeit --module-path lib -
jar crutils.jar -configPath "C:\Program Files\Automation Anywhere
\Enterprise\config" -action [UPDATE_KEY_VAULT_CONFIGURATION or
 UPDATE_DB_AUTHENTICATION_CONFIGURATION]

You can update either of these configuration actions:
• Enter UPDATE_KEY_VAULT_CONFIGURATION to edit the CyberArk key vault configuration.
• Enter UPDATE_DB_AUTHENTICATION_CONFIGURATION to change to database

authentication using external key vault.

2. Based on which configuration action you used, choose the appropriate action:
• Update key vault configuration for CyberArk: If you entered

UPDATE_KEY_VAULT_CONFIGURATION as the configuration action:
a. After the utility loads the current key vault configuration and properties, and this prompt is

displayed: Enter key vault [AWS/CYBERARK/AZURE/NONE] :, enter CYBERARK
b. At the Please enter Vault URL: prompt, enter (for example): https://

services.uscentral.skytap.com:19516

c. At the Please enter Application ID: prompt, enter (for example): AAEControlRoom
d. At the Please enter Certificate path: prompt, enter (for example): C:\Users

\Admin\Downloads\client_combined_cert_key_Adminat1234.p12

Nota:  The client certificate issued to the Control Room for authenticating to CyberArk must
be in .p12 (pkcs#12) format with the private key.

e. At the Passphrase will not be displayed on the console Passphrase:
prompt, enter your passphrase.

The key vault utility runs. If the configuration was successful (the utility was able to connect to the
external key vault using the configured parameters), these messages are displayed on the console:

Connection configurations valid
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  Key Vault configurations successfully updated

• Update database authentication for CyberArk: If you entered
UPDATE_DB_AUTHENTICATION_CONFIGURATION as the configuration action:
a. After the utility loads the current database configuration information, this prompt is displayed:

Database authentication configurations loaded
Currently configured database authentication [SQL]

Change database authentication. Available options:
WINDOWS: Connect to database using windows authentication
SQL: Connect to database using SQL server authentication, manually
 enter username and password
KEY_VAULT: Connect to database using SQL server authentication,
 retrieve username and password from external key Vault 

Enter database authentication [WINDOWS/SQL/KEY_VAULT]:

Enter KEY_VAULT
b. At the Please enter Safe name: prompt, enter (for example): aa_vb_safe
c. At the Please enter Object name: prompt, enter (for example): Database-MSSql-

administrator-admin

The key vault utility runs. If the database configuration was successful (the utility was able to
connect to CyberArk, retrieve the designated credential and then use the credential to connect to
the database), these messages are displayed on the console:

Database Credentials are valid
Database authentication configurations successfully updated

Cloud integration using CyberArk Password Vault
You connect and integrate the external CyberArk Password Vault to the Automation 360 Control Room.
The following image shows CyberArk Cloud integration with the Control Room:

You must configure the customer network perimeter firewall to allow access to the
CyberArk_CCP_hostname:port from the Automation 360 Cloud AWS NAT Gateway IP addresses.
The following table provides an example of how to configure the customer perimeter firewall:
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Da A Protocol used

Control Room in Automation
360 Cloud: Three AWS NAT
Gateway IP addresses

CyberArk_CCP
API_hostname:port

For example:
cyberarkpwv.dev.abcd.com:4043

TLS Encrypted CCP API
(TLS mutually authenticated)

For more details, see Automation 360 IP addresses for external integrations alla pagina 2757.
For Cloud integrations, you can configure the Control Room and external key vault integration using the
Automation 360 Control Room user interface.
The Agent auto-login and Agent automation use cases are only supported on Automation 360 Cloud
Control Room instances. Neither of these use cases affect the Control Room boot sequence or Control
Room functionality.

Nota:  Bootstrap and service account credential retrieval use cases are not supported on Cloud Control
Room instances because the database and services are managed internally by Automation Anywhere.
There is no compliance use case (requirement) for these credentials to be stored in the customer external
key vault.

1. Gather the specific CyberArk information required to configure the external key vault connector using
the Automation 360 Control Room.

Elemento Descrizione

URL archivio The CyberArk AIM server CCP API
URL (for example: https://
<hostname:port_num>/

Nota:  To access the CCP APIs, the
Control Room will automatically append /
AIMWebService/api/Accounts? to the
vault URL you enter. As a result, you must
configure the Web Service on the CyberArk
AIM server as AIMWebService

ID applicazione The CCP API AppID (for example:
AAEControlRoom).
Per informazioni, consulta Define CyberArk
application ID alla pagina 2863.
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Elemento Descrizione

File del certificato Enter the path to the client certificate issued
to the Control Room server.
The client certificate file that is issued
for the Control Room is a .p12 file that
contains the private key. CyberArk admins
configure this file on the CyberArk server.
After configuring the certificate file, it is
used to authenticate every client request
that is sent from the Automation 360 Cloud
Control Room to the CyberArk server.
The certificate will be issued to the
Cloud Control Room (Subject: field of the
certificate will contain fully qualified domain
name (FQDN) of the Control Room) by the
customer internal certificate authority.

Certificate file password A password used to open the certificate file.

Server certificate - PEM format (Required only for Cloud integration): The
server certificate without the private key of
the CyberArk AIM server (Subject: field of
the certificate will contain the FQDN of the
CyberArk AIM server).
This server certificate is a public certificate
for the URL where CyberArk is hosted. This
certificate is in the PEM text format and
contains the Subject Alternative Names
(SAN) on which the CyberArk is listening to
requests. Per ulteriori informazioni, consulta
CyberArk CACert.

2. Log in to the Automation 360 Control Room as the Administrator.
3. From the Control Room, navigate to Administration > Settings > External key vault .
4. Click the Edit icon to open the Configuration settings pane.
5. Click CyberArk and then enter the specific CyberArk information described in the preceding table.
6. Click Save changes to connect the external key vault.

CyberArk credential retrieval use cases
You can retrieve CyberArk credentials for these use cases: bootstrap, system, auto-login, and automations.

Retrieve Control Room bootstrap credentials with CyberArk

The Automation 360 Control Room uses bootstrap credentials to access supporting services such as
database, service account, and Active Directory (AD). You configure these credentials during the initial On-
Premises installation or post-installation (using the key vault utility) by specifying the safe name and object
name.
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The following images shows the process of retrieving the Control Room bootstrap credentials with
CyberArk:

When required during the bootup sequence or normal operations (such as refreshing a service
authentication), the Control Room uses the key vault connection to retrieve the credential and perform the
required authentication.

Nota:  You must select the Microsoft SQL Server Authentication for this use case; other database
authentication methods are not supported for bootstrap.

Retrieve Control Room system credentials with CyberArk

Nota:  You can configure the service account only during the initial installation.

If you configured an external key vault during the initial installation, you can then use the Automation 360
user interface (post-installation) to configure SMTP and Active Directory (AD) credentials.
1. Log in to the Automation 360 Control Room as the Administrator.
2. From the Control Room, navigate to: Administration > Settings > Email Settings.
3. You can map the AD Master Account credential from the external key vault, configure external

credentials, or set to manual (switch modes of AD Master Account credential retrieval).

Retrieve auto-login credentials with CyberArk

Auto-login credentials are used to authenticate to an Automation 360 Bot Agent device and start an active
Windows session. Robotic Process Automation (RPA) requires an active Windows session to function. Auto-
login occurs prior to the automation running when automations are launched from a remote Bot Agent
device.
The following image shows the process of retrieving the auto-login credentials with CyberArk:
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A Control Room administrator can manually launch or schedule a job to launch an automation on a Bot
Agent device by specifying these details:
• Automation (bot) name
• Nome dispositivo
• User context

The system performs auto-login to the specified device with the user name and password associated with
the user context, and then runs the automation on the device.
To configure retrieval of auto-login credentials from the external key vault, perform these steps:
1. Log in to the Automation 360 Control Room as the Administrator.
2. From the Control Room, navigate to Administration > Settings > Devices.
3. Scroll down to the auto-login settings section and click Edit.
4. If you previously configured CyberArk as the external key vault connection, click Enabled to retrieve

the auto-login credentials from that external key vault.
If this option is disabled, then the external key vault connection was not configured.

Nota:  If you disable auto-login from the external key vault, then credentials are retrieved using the
AAI Credential Vault and its stored credentials instead.

5. Enter the Safe name (for example: AA_Auto-login_Safe).
The safe name you enter is also known as the Auto-login Credential Safe.

Nota:  You can only define a single safe to retrieve auto-login credentials, so all auto-login credentials
must be in the designated safe.

6. Fai clic su Salva modifiche.
If successful, then the auto-login settings successfully saved message is displayed.

CyberArk auto-login credential example

For this auto-login credential retrieval example, consider a Control Room user who wants to deploy a bot
on a device as a specific user. This example uses the following details:
• Automation (bot) name run on a device = ProcureToPayGeoEast
• Agent device name = WinVDI1138
• Agent user context = roboticworker2112@automation.abcd.com
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The following image shows this an example of retrieving auto-login credentials with CyberArk:

Before starting the automation, ensure the following:
1. The Control Room connection details have been successfully configured, and the Control Room uses

these connection details to connect to CyberArk and performs authentication.
2. The Control Room queries the Bot Agent device running on device WinVDI1138 to check if there is

an active Windows (operating system) session currently on device WinVDI1138, and if that session
belongs to Agent user robiticworker2112.
If there is an existing session on the device for user robiticworker2112, then there is no need to
perform auto-login and the bot continues with the deployment.

3. However, if there is an no active session or if there is an active session that does not belong to
robiticworker2112, then the Control Room retrieves the auto-login credential from the CyberArk
Password Vault.

4. The Control Room passes the credential (password) to theBot Agent. The Bot Agent performs a
Windows login on device WinVDI1138 as robiticworker2112 (first, logging off any other user
login session) using the auto-login credential for robiticworker2112. The automation (Bot)
ProcureToPayGeoEast then starts to run on device WinVDI1138 as robiticworker2112.

Retrieve automation credentials with CyberArk

Automation credentials are variables used by bot developers within automation (bot) actions that define
and retrieve data from encrypted storage. The automation uses the credentials to authenticate to
applications (for example: finance application). Automation credentials are retrieved by the Automation
360 Bot Agent during runtime. Within CyberArk, a safe is a locker, and an object is a credential.
The following image shows the process of retrieving automation credentials with CyberArk:
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Automation credentials retrieved from the CyberArk Password Vault are mapped in the Automation
Anywhere Credential Vault. The Credential Vault supports these two types of automation credentials:

System credentials Credentials where the value returned by the
credential variable is the same for any automation
that uses that variable.

User-defined credentials Credentials where the value returned by the
credential variable is distinct based on the user
context in which the automation is running.

For both system credentials and user-defined credentials, the bot developer specifies the same credential
variable within the bot code. Then, the system determines which credential to retrieve during bot runtime.
User-defined credentials simplify automation development by enabling bot developers to write code using
a single credential variable where the RPA platform substitutes the value returned during runtime with
a unique user-specific value. Developers can avoid writing duplicate code with different user-specific
credential variables.
The following image shows the relationship between the Automation Anywhere Credential Vault objects
and the CyberArk credentials for system and user-defined credentials:

• The Control Room locker (Locker1) is mapped to the CyberArk safe name (Safe1).
• The Control Room system credential (Credential1) is mapped to the CyberArk object (Object1).

As an administrator, you create and configure a locker and credentials using the external key vault feature
in the Automation 360 Control Room. Within the Control Room, an administrator maps the Automation
Anywhere locker (Locker1) to a safe name (Safe1) and maps the credential (Credential1) to an object
name (Object1). The credentials available to Control Room users are determined by what is configured in
the external key vault (CyberArk Password Vault).
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If you want to use user-defined credentials with the CyberArk integration, then the CyberArk administrator
must create objects for each user-defined credential by naming those objects with the Control
Room_username postfix. During runtime, the RPA platform retrieves the object name that is named with a
postfix that matches the user context (user-defined credential) in which the automation is running. If there
is no user-defined credential, then the RPA platform retrieves the object name without a username postfix
(and uses the system credential).

Nota:  You can map any Automation Anywhere locker to any CyberArk Safe Name. However, any safe
names you use to map automation credentials should be distinct from the safe names you use for auto-
login.

As an administrator, you can use the access controls in the Automation 360 Control Room to separate
access to credentials by providing users access to a locker. You control access to credentials by assigning
different Control Room users to different roles and then associating different lockers with those roles.
By mapping different CyberArk safes to different lockers, access to credentials in the CyberArk safes is
mapped to and enforced by the access controls in the Control Room.

Nota:  The same permissions and privileges (assigned through roles) in the Control Room apply to
credentials mapped to the external key vault.

CyberArk automations credentials retrieval example

To configure automation credentials retrieval and integrate with the CyberArk Password Vault, you first
create a locker and then create credentials.
To create a locker to integrate with the CyberArk Password Vault, perform these steps:
1. From the Automation 360 Control Room, navigate to Manage > Credential.

A user with Manage my credentials and lockers permissions is authorized to create credentials.
2. Click the Lockers tab.
3. Click Create locker.
4. Inserisci un nome per il locker.

This name is local to the Control Room and does not have any dependency on the CyberArk safe
name.

5. Click External Key Vault and enter the CyberArk safe name in the Safe name field (for example:
Finance_Safe).

6. Fai clic su Avanti.
7. Configure Owners, Managers, Participants, and Consumers for the locker.
8. Click Create locker.

Consulta Crea locker alla pagina 2844.

The Control Room is now ready to retrieve credentials and enforce access controls on the mapped
CyberArk safe. To continue, you now create the credentials.
To create a credential to integrate with the CyberArk Password Vault, perform these steps:
1. From the Automation 360 Control Room, navigate to Manage > Credentials.

A user with Manage my credentials and lockers permissions is authorized to create credentials.
2. From the Credentials tab, select Create Credential.
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3. Enter the credential name in the Credential name field.
This name is local to the Control Room and does not have any dependency on the CyberArk safe
name.

4. Click External key vault below the name field.
5. From the list of available lockers, select the appropriate locker that was previously mapped to the safe

name for the credential you are now mapping to the object (credential).
6. Enter the CyberArk object name in the Object name field.
7. Click Validate and retrieve attributes.

The system validates the mapping by attempting to retrieve from the CyberArk Password Vault the
combination of safe name (locker) and object name (credential). Within the safe name mapped to the
locker, Automation 360 expects objects to use the correct naming conventions. . Consulta External key
vault naming conventions alla pagina 2853.
If validation fails, then no object exists in the CyberArk Password Vault with the name that matches
the combination of safe name (locker) and object name (credential).
When the system successfully retrieves the object details, it will display the CyberArk Password Vault
object attributes (the fields within the secret).

8. From the list of attributes, select attributes to map to the credential.
9. Click Create credential.

If successful, then the credential successfully created message is displayed.

Integrating Azure Key Vault with Automation 360
You integrate the Automation 360Control Room to retrieve credentials from the Azure Key Vault.
The credentials become resident within the Azure Key Vault where they are managed, rotated, and
synchronized.
You can integrate Automation 360 with the Azure Key Vault using either of these deployments:
• Cloud
• On-Premises

The following diagram shows an Automation 360 Cloud deployment where with Azure Key Vault:
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For On-Premises deployments, you deploy the following:
• Control Room as software within your customer environment.
• Bot Agent within your customer environment where automations run and access customer applications.

Importante:  You can edit the external key vault connection settings through the user interface in Cloud
deployments only. External key vault settings in On-Premises deployments are only configurable during
installation or with the key vault utility post-installation. Customers will need to ensure connectivity to the
external key vaults from their On-Premises deployed Control Room instances.

On-Premises integration using Azure Key Vault
As an Automation 360 administrator, you can configure the Azure On-Premises integration using one of
these methods: initial installation or post-installation using a command-line interactive key vault utility.
Within the On-Premises installation wizard, bootstrap credential retrieval from external key vault
configuration options are only available if you first configure the key vault connection. The configuration
options vary based on the external key vault you select.
Choose your integration method:
• Initial installation
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• Post-installation using key vault utility

On-Premises initial installation using Azure Key Vault
Using the initial installation method, you can connect and configure the external key vault connector,
service account credential (Active Directory master password), and bootstrap (database) credential
identifier.

Nota:  You must select Microsoft SQL Server Authentication as the database; other database
authentication methods are not supported for this use case.

You can configure the SMTP and AD credential identifier to retrieve from the external key vault using the
Automation 360 user interface.
1. Configure the Azure Key Vault requirements from the Microsoft Azure portal.
2. Integrate the Azure Key Vault and Automation 360 Control Room.
3. Set up the authentication type for Automation 360 Control Room users and Azure Key Vault.

After you successfully complete the initial installation, the Automation 360 Control Room can access and
retrieve credentials within the Azure Key Vault.
Configure Azure Key Vault requirements for initial installation
Before you can integrate the Automation 360 Control Room with the Azure Key Vault, you must configure
Azure Key Vault requirements using the Microsoft Azure portal.
1. Sign in to the Microsoft Azure portal: Azure portal

2. Create a key vault in Azure.
Consulta Quickstart: Create a key vault using the Azure portal.

3. From the Azure Home page, navigate to Home > selected key vault. Generate or import secrets for
the use cases you will be using with the Azure Key Vault.
For example, if you will be using the bootstrap use case, you should generate a secret that contains
the correct database credential that the Control Room will use to authenticate to the database.

4. Collect the following required Azure environment variables that must be set in the environment of the
Control Room Server Microsoft operating system:
• AZURE_CLIENT_ID: The client (application) ID of an App Registration in the tenant.
• AZURE_CLIENT_SECRET: A client secret that was generated for the App Registration.
• AZURE_TENANT_ID: The Azure Active Directory tenant (directory) ID.
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5. After you set the environment variables in Azure, you must then add them to the Server Environment
on the Automation 360 Control Room:

The Azure Key Vault has a flat name space with no organizational containers. There is no safe or locker
within the Azure Key Vault and all credentials are stored together in the same container. Credentials are
stored in objects which only have a secret name.
For RBAC policies and best practices, see What is Azure RBAC?

Integrate Azure Key Vault and Control Room
After you configured the Azure Key Vault requirements using the Microsoft Azure portal, you can integrate
the Azure Key Vault and the Automation 360 Control Room.
1. After you start the Automation 360 installation wizard, select On-premises as the Deployment

Option and click Next.
2. Accept the license agreement and click Next.
3. Select Custom as the Installation Type Preference and click Next.
4. Click Change... to change the destination folder of where to install Automation 360. Browse to select

the folder destination you want and click Next.
5. To connect and configure the external key vault integration, select Azure.

6. In the Vault URL field, enter the Azure Key Vault URL (for example: https://user-db-
vault.vault.azure.net/.

7. Accept the default settings from the TLS Configuration dialog box and click Next.
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8. From the Service Credentials dialog box, select an option to specify the Azure Secret name used
by the Control Room and click Next.

9. From the Database Authentication dialog box, select an option to specify the Secret name from
Azure instead of manually entering the secret name the Control Room uses to authenticate to the
database.

a) Click SQL Server authentication (retrieve credential from external key vault), and then
enter the Azure Secret Name value.

b) Click Next to continue and complete the initial installation.

After you successfully complete the initial installation, the Automation 360 Control Room can access and
retrieve credentials within the Azure Key Vault.
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Set up authentication type for Azure Key Vault
After you complete the initial installation and configure Azure Key Vault as the external key vault, you can
set up the authentication type for Automation 360 Control Room users in the Initial Setup (this occurs
directly after the initial installation completes).
1. From the Authentication type for Control Room users dialog box, click Active Directory.

2. Opzionale: Configure the Active Directory integration credential (this is the credential that the Control
Room uses to authenticate users with Active Directory) to be retrieved from Azure Key Vault. Click
External Key vault and enter the Azure secret to retrieve credentials in the field (for example:
userAD).

3. Click Discover connections. The available domains and sites display.
4. Click Next and continue to create the Control Room first admin. Save the Admin user information.

The Control Room will attempt to retrieve the credential from the Azure Key Vault and then
authenticate to the Domain Controller. If this fails, cause might be one of the following:
• There is no secret with that name in the Azure Key Vault
• There is a secret with that name, but it does not contain a username and password that is

authorized for authentication with Active Directory

You can now log in to the Control Room as admin and add users and roles.

Nota:  The passwords within the Azure Key Vault are masked so ensure that you copy and save them after
you create them.

On-Premises post-installation using Azure Key Vault
You use the command-line interactive key vault utility during a scheduled system downtime
and you must stop all running Control Room services. You should coordinate any key vault
configuration changes that might impact connectivity parameters (such as AZURE_CLIENT_ID,
AZURE_CLIENT_SECRET, and AZURE_TENANT_ID) during downtimes with the Azure administrative
team.

Nota:  If you use the key vault utility to disable Azure Key Vault integration, you must first unmap any
mapped credentials that are in use.

Using the post-installation method, you can perform these actions:
• Modify or configure the external key vault connection parameters.
• (If not configured during initial installation) Modify or configure the service account credential (Active

Directory master password).
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• (If not configured during initial installation) Modify or configure the database (bootstrap) credential
identifier (retrieved when authenticating the database).

Nota:  Retrieving bootstrap credentials from an external key vault might cause the Control Room to fail
if the external key vault is not accessible during boot-up, or if the external key vault is not accessible
when the Control Room refreshes database connections and authenticates users with Active Directory.

• Recover the Control Room for these reasons:
• By modifying the external key vault connection parameters, the service account, and database

credential safe and object identifiers.
• If Azure Key Vault connection parameters changes caused the Control Room to experience

connectivity issues.
• When credential identifiers for bootstrap passwords change.

You can address any initial configuration settings that were not set correctly and recover the system.

You can configure and edit SMTP and AD credential identifiers to retrieve information from the external
key vault from the Automation 360 Control Room by navigating to Administration > Settings > Active
Directory.
1. Run the key vault utility for the Azure Key Vault: To run the key vault utility and update key

vault connection settings:
a) As the Control Room administrator, access the Automation Anywhere Control Room installation

directory that was created during the initial Automation 360 installation.
Ad esempio: C:\Program Files\Automation Anywhere\Enterprise

b) Download the latest version of the key vault utility. To download the jar file used to update the
directory, open a browser and access the A-People site: A-People Downloads page (Login required).

Nota:  If DB authentication is configured to use external key vault, the utility returns the
following exception: Database currently configured to retrieve credentials
 from key vault. Update database authentication to WINDOWS/SQL to
 proceed further and exit.

The utility requests the user to confirm the action: Disable/update of key vault might
 impact functionalities using key vault (for example, Active Directory
 configuration, Email Settings configuration). Make sure to update these
 settings (if any). Are you sure you want to continue?

c) Enter Y to continue.
d) Enter the following:

> jdk11\bin\java -jar certmgr.jar -appDir . -importTrustCert <Full path
 of the certificate>

e) Add these jvm arguments to the command to run the key vault utility:
1. -Djavax.net.ssl.trustStore="C:\Program Files\Automation Anywhere

\Enterprise\pki\trust\store.ks"

2. -Djavax.net.ssl.trustStorePassword=changeit --module-path lib -
jar crutils.jar -configPath "C:\Program Files\Automation Anywhere
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\Enterprise\config" -action [UPDATE_KEY_VAULT_CONFIGURATION or
 UPDATE_DB_AUTHENTICATION_CONFIGURATION]

You can update either of these configuration actions:
• Enter UPDATE_KEY_VAULT_CONFIGURATION to edit the Azure Key Vault configuration.
• Enter UPDATE_DB_AUTHENTICATION_CONFIGURATION to change to database

authentication using external key vault.

2. Based on which configuration action you used, choose the appropriate action:
• Update key vault configuration for Azure: If you entered

UPDATE_KEY_VAULT_CONFIGURATION as the configuration action:
a. After the utility loads the current key vault configuration and properties, and this prompt is

displayed: Enter key vault [AWS/CYBERARK/AZURE/NONE] :, enter AZURE
b. At the Please enter Vault URL: prompt, enter (for example): https://user-db-

vault.vault.azure.net/

The key vault utility runs. If the configuration was successful (the utility was able to connect to the
external key vault using the configured parameters), these messages are displayed on the console:

Connection configurations valid
  Key Vault configurations successfully updated

• Update database authentication for Azure: If you entered
UPDATE_DB_AUTHENTICATION_CONFIGURATION as the configuration action:
a. After the utility loads the current database configuration information, this prompt is displayed:

Database authentication configurations loaded
Currently configured database authentication [SQL]

Change database authentication. Available options:
WINDOWS: Connect to database using windows authentication
SQL: Connect to database using SQL server authentication, manually
 enter username and password
KEY_VAULT: Connect to database using SQL server authentication,
 retrieve username and password from external key Vault 

Enter database authentication [WINDOWS/SQL/KEY_VAULT]:

Enter KEY_VAULT
b. At the Please enter Secret name: prompt, enter (for example): testDB

The key vault utility runs. If the database configuration was successful (the utility was able to
connect to Azure, retrieve the designated credential and then use the credential to connect to the
database), these messages are displayed on the console:

Database Credentials are valid
Database authentication configurations successfully updated
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Cloud integration using Azure Key Vault
For Cloud integrations, you can configure the Control Room and external key vault integration using the
Automation 360 Control Room user interface.
The Agent auto-login and Agent automation use cases are only supported on Automation 360 Cloud
Control Room instances. Neither of these use cases affect the Control Room boot sequence or Control
Room functionality.

Nota:  Bootstrap and service account credential retrieval use cases are not supported on Cloud Control
Room instances because the database and services are managed internally by Automation Anywhere.
There is no compliance use case (requirement) for these credentials to be stored in the customer external
key vault.

1. Gather the specific Azure information required to configure the external key vault connector using the
Automation 360 Control Room.

Elemento Descrizione

URL archivio The Azure Key Vault URL of the resource
group (for example: https://user-db-
vault.vault.azure.net/).

ID client The client (application) ID of an App
Registration in the tenant.

Client segreto A client secret that was generated for the
App Registration.

ID tenant The Azure Active Directory tenant (directory)
ID.

2. Log in to the Automation 360 Control Room as the Administrator.
3. From the Control Room, navigate to Administration > Settings > External key vault.
4. Click the Edit icon to open the Configuration settings pane.
5. Click Azure and then enter the specific Azure information described in the preceding table.
6. Click Save changes to connect the external key vault.

Azure credential retrieval use cases
You can retrieve Azure credentials for these use cases: bootstrap, system, auto-login, and automations.

Retrieve Control Room bootstrap credentials

Nota:  This use case applies to On-Premises deployments only.

The Automation 360 Control Room uses bootstrap credentials to access supporting services such as
database, service account, and Active Directory (AD). You configure these credentials during the initial On-
Premises installation or post-installation (using the key vault utility) by specifying the object name.
The following image shows the process of retrieving the Control Room bootstrap credentials with Azure:
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When required during the bootup sequence or normal operations (such as refreshing a service
authentication), the Control Room uses the key vault connection to retrieve the credential and perform the
required authentication.

Nota:  You must select the Microsoft SQL Server Authentication for this use case; other database
authentication methods are not supported for bootstrap.

Retrieve Control Room system credentials

Nota:  This use case applies to On-Premises deployments only, and you can configure the service account
only during the initial installation.

If you configured an external key vault during the initial installation, you can then use the Automation 360
user interface (post-installation) to configure SMTP and Active Directory (AD) credentials.
1. Log in to the Automation 360 Control Room as the Administrator.
2. From the Control Room, navigate to: Administration > Settings > Email Settings.
3. You can map the AD Master Account credential from the external key vault, configure external

credentials, or set to manual (switch modes of AD Master Account credential retrieval).

Retrieve auto-login credentials

Nota:  This use case applies to both On-Premises and Cloud deployments.

Auto-login credentials are used to authenticate to an Automation 360 Bot Agent device and start an active
Windows session. Robotic Process Automation (RPA) requires an active Windows session to function. Auto-
login occurs prior to the automation running when automations are launched from a remote Bot Agent
device.
The following image shows the process of retrieving the auto-login credentials with Azure:
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A Control Room administrator can manually launch or schedule a job to launch an automation on a Bot
Agent device by specifying these details:
• Automation (bot) name
• Nome dispositivo
• User context

The system performs auto-login to the specified device with the user name and password associated with
the user context, and then runs the automation on the device.
You must have a secret for each Control Room user for whom the auto-login credentials will be retrieved
from the external key vault, and the secret name in the Azure Key Vault must match the Control Room
username.
To configure retrieval of auto-login credentials from the external key vault, perform these steps:
1. Log in to the Automation 360 Control Room as the Administrator.
2. From the Control Room, navigate to Administration > Settings > Devices.
3. Scroll down to the auto-login settings section and click Edit.
4. If you previously configured Azure Key Vault as the external key vault connection, click Enabled to

retrieve the auto-login credentials from that external key vault.
If this option is disabled, then the external key vault connection was not configured.

Nota:  If you disable auto-login from the external key vault, then credentials are retrieved using the
AAI Credential Vault and its stored credentials instead.

5. The Azure Key Vault has a flat name space without any organizational containers, so you do not need
to enter a Safe name. Fai clic su Salva modifiche.

If successful, then the auto-login settings successfully saved message displays.

Auto-login naming conventions

The Control Room retrieves auto-login credentials based on the object naming convention within the
external key vault. The Control Room searches for an object where the object name (the credential name
in the external key vault) matches the Control Room username for which it is performing auto-login.
The prefix autologin_ is required as part of the naming convention for auto-login credentials for all
external key vaults: CyberArk, AWS, and Azure. The name of the auto-login credential in the external key
vault must contain autologin_ followed by the Control Room username. In some cases, certain key
vaults have restrictions on the characters that can be used in credential object names. Additionally, to
support how different use cases encode credentials, Automation 360 requires that certain characters be
reserved or encoded.
The following table lists examples of the object naming conventions expected in the Control Room:

Control Room username Expected object name format

ABCD\user123 autologin_ABCD--user123

user123@rpa.abcd.com autologin_user123-40-rpa-2e-abcd-2e-com

Nota:  For On-Premises customers using AD authentication, you must format auto-login usernames using
the UPN format or domain\username postfix.
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For auto-login credentials, keep these in mind:
• The object name in the external key vault must contain autologin_ as a prefix.
• The auto-login credential names must map to the Control Room username (login ID) for the credential

being retrieved.
Some external key vaults have usage restrictions of certain characters, such as backslash (\) and
ampersand (@) in the secret name (object name), and restrictions on how special characters are
interpreted within API calls. If the user ID contains special characters, then you must encode the secret
name (object name) in the external key vault using ASCII code character substitutions, as listed in the
following table.

This character Changes to this ASCII code character
substitution

\ (backslash) --

- (dash) -2d-

_ (underscore) -5f-

@ (ampersand) -40-

. (period) -2e-

Nota:  Except for the backslash being mapped to double dashes, the dash, period, underscore, and
ampersand are mapped using their ASCII code bracketed in dashes.

Azure auto-login credential example

For this auto-login credential retrieval example, consider a Control Room user who wants to deploy a bot
on a device as a specific user. This example uses the following details:
• Automation (bot) name run on a device = ProcureToPayGeoEast
• Agent device name = WinVDI1138
• Agent user context = rpauserCR1@abcd.com

The following image shows this an example of retrieving auto-login credentials with Azure:
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Before starting the automation, ensure the following:
1. The Control Room connection details have been successfully configured, and the Control Room uses

these connection details to connect to Azure and performs authentication.
2. The Control Room queries the Bot Agent device running on device WinVDI1138 to check if there is

an active Windows (operating system) session currently on device WinVDI1138, and if that session
belongs to Agent user rpauserCR1.
If there is an existing session on the device for user rpauserCR1, then there is no need to perform
auto-login and the bot continues with the deployment.

3. However, if there is an no active session or if there is an active session that does not belong to
rpauserCR1, then the Control Room retrieves the auto-login credential from the Azure Key Vault.

4. The Control Room passes the credential (password) to theBot Agent. The Bot Agent performs
a Windows login on device WinVDI1138 as rpauserCR1 (first, logging off any other
user login session) using the auto-login credential for rpauserCR1. The automation (Bot)
ProcureToPayGeoEast then starts to run on device WinVDI1138 as rpauserCR1.

Retrieve automation credentials

Nota:  This use case applies to both On-Premises and Cloud deployments.

Automation credentials are variables used by bot developers within automation (bot) actions that define
and retrieve data from encrypted storage. The automation uses the credentials to authenticate to
applications (for example: finance application). Automation credentials are retrieved by the Automation
360 Bot Agent during runtime.
The following image shows the process of retrieving automation credentials with Azure:

Automation credentials retrieved from the Azure Key Vault are mapped in the Automation Anywhere
Credential Vault. The Credential Vault supports these two types of automation credentials:

System credentials Credentials where the value returned by the
credential variable is the same for any automation
that uses that variable.

User-defined credentials Credentials where the value returned by the
credential variable is distinct based on the user
context in which the automation is running.

For both system credentials and user-defined credentials, the bot developer specifies the same credential
variable within the bot code. Then, the system determines which credential to retrieve during bot runtime.
User-defined credentials simplify automation development by enabling bot developers to write code using
a single credential variable where the RPA platform substitutes the value returned during runtime with
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a unique user-specific value. Developers can avoid writing duplicate code with different user-specific
credential variables.
The following image shows the expected naming convention for Azure credentials:

The diagram shows six secrets in the Azure Key Vault which can be mapped to two credentials within the
Control Room Credential Vault
• Object3
• Object4

For example, you can map a locker in the Control Room to either prefixID3 or prefixID4. Then, you
map the secret to a credential. For each credential, the secrets will be consumed (retrieved by the Control
Room) as a system-defined credential (without username postfix) and two user-defined credentials (one
each for the Control Room users whose usernames are User1ID1 and User1ID2).

Nota:  Within the Control Room Credential Vault, the name of the locker and the name of the credential
are arbitrary and local to the Control Room. You map these names to specific secrets in the external key
vault.

Within Azure Key Vault, each automation credential is stored with a name that contains specific identifiers
including: a prefix, object identifier, and an optional postfix which identifies a username. This is a required
naming convention that assures retrieval of the correct credential. The name of the secret (the credential)
in Azure Key Vault encodes information about the mapping within the Automation Anywhere Credential
Vault.
As an administrator, to map a Control Room to Azure Key Vault, you create and configure a locker and a
credential using the external key vault option within the Create Locker and Create Credential features
in the Automation 360 Control Room:
• You configure a locker in the Credential Vault to map to an Azure secret name prefix.
• You configure credentials in the Credential Vault that map to an Azure secret object identifier (optional

postfix for user-defined credential).

During runtime, the RPA platform retrieves the secret that is named with a postfix that matches the user
context (user-defined credential) in which the automation is running. If there is no user-defined credential,
then the RPA platform retrieves the secret without a username postfix (system credential).
The Control Room implements access controls to the external credentials through permissions within roles.
You control access to credentials by assigning different Control Room users to different roles and then
associating different lockers with those roles.
The following image shows the Control Room Credential Vault locker and credential mapped to an Azure
secret:
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Importante:  When creating an externally mapped credential, you must place the credential in the
appropriate externally mapped locker (the locker is mapped to the prefix in the secret name). The Azure
secret name will have a naming convention: Prefix + Secret_Name_Body + Postfix (optional for
user-defined credentials).

Nota:  The same permissions and privileges (assigned through roles) in the Control Room apply to
credentials mapped to the external key vault.

Automation naming conventions

The following table shows Azure Key Vault external key vault examples using naming conventions for
automation.

Nota:  The Azure Prefix maps to the locker for the Control Room, and the Azure Secret Body maps to the
credential for the Control Room.

Automation
credential
example

Azure Prefix Azure Secret Body Secret in Azure Control Room
username

accounting_cv1
System credential
in locker mapped
to Azure Secret
name prefix
accounting

accounting cv1 pdf-5f-cv1
(system)

None - system
credential

accounting_cv1_ABCD
\user123
User-defined
credential in locker
mapped to Azure
prefix

accounting cv1 pdf-5f-cv1-5f-
ABCD--user123

ABCD\user123
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When deploying Azure credentials, the Azure Key Vault character underscore (_) is a reserved character
and cannot be used in credential names. You must substitute any underscore (_) usage with the ASCII
code value 5f bracketed by dashes:

This character Changes to this ASCII code character
substitution

\ (slash) --

- (dash) -2d-

_ (underscore) -5f-

@ (ampersand) -40-

. (period) -2e-

Azure automations credentials retrieval example

To configure automation credentials retrieval and integrate with the Azure Key Vault, you first create a
locker and then create credentials.
To create a locker to integrate with the Azure Key Vault, perform these steps:
1. From the Automation 360 Control Room, navigate to Manage > Credential.

A user with Manage my credentials and lockers permissions is authorized to create credentials.
2. From the Credentials tab, select Create Locker.
3. Enter a name for the locker (for example, Locker3).

This name is local to the Control Room and does not have any dependency on the Azure secret name.
4. Click External Key Vault and enter the Azure secret name prefix (for example: prefixID3). You

must name secrets within the Azure Key Vault using the name prefix for the configuration of the
mapping to complete successfully.

5. Fai clic su Avanti.
6. Configure Owners, Managers, Participants, and Consumers for the locker.
7. Click Create locker.

Consulta Crea locker alla pagina 2844.

The Control Room is now ready to retrieve credentials and enforce access controls on all Azure secrets with
the prefix prefixID3. To continue, you now create the credentials.
To create a credential to integrate with the Azure Key Vault, perform these steps:
1. From the Automation 360 Control Room, navigate to Manage > Credentials.

A user with Manage my credentials and lockers permissions is authorized to create credentials.
2. From the Credentials tab, select Create Credential.
3. Enter the credential name in the Credential name field.

This name is local to the Control Room and does not have any dependency on the Azure secret name.
4. Click External key vault below the name field.
5. From the list of available lockers, select the appropriate locker that was previously mapped to the

secret name prefix for the secrets you are now mapping to the credential.
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6. Enter the Azure Secret_Name_Body in the Secret name field (for example: Object3).
7. Click Validate and retrieve attributes.

The system validates the mapping by attempting to retrieve from the Azure Key Vault a secret with the
name Prefix_Secret_Name_Body (for example: prefixID3_Object3.
If validation fails, then no secret exists in the Azure Key Vault with the name that matches the
combination of locker (prefix) and credential (Secret_Name_Body). In this example, there is no
secret in the Azure Key Vault named prefixID3_Object3.
When the system successfully retrieves the secret, it will display the Azure Key Vault secret attributes
(the fields within the secret).

8. From the list of attributes, select attributes to map to the credential.
9. Click Create credential.

If successful, then the credential successfully created message displays.

Integrating AWS Secrets Manager with Automation 360
You integrate the Automation 360Control Room to retrieve credentials from the AWS Secrets Manager.
The credentials become resident within the AWS Secrets Manager where they are managed, rotated, and
synchronized.
You can integrate Automation 360 with the AWS Secrets Manager using either of these deployments:
• Cloud
• On-Premises

The following diagram shows an Automation 360 Cloud deployment where with AWS Secrets Manager:
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For On-Premises deployments, you deploy the following:
• Control Room as software within your customer environment.
• Bot Agent within your customer environment where automations run and access customer applications.

Importante:  You can edit the external key vault connection settings through the user interface in Cloud
deployments only. External key vault settings in On-Premises deployments are only configurable during
installation or with the key vault utility post-installation. Customers will need to ensure connectivity to the
external key vaults from their On-Premises deployed Control Room instances.

On-Premises integration using AWS Secrets Manager
As an Automation 360 administrator, you can configure the AWS On-Premises integration using one of
these methods: initial installation or post-installation using a command-line interactive key vault utility.
Within the On-Premises installation wizard, bootstrap credential retrieval from external key vault
configuration options are only available if you first configure the key vault connection. The configuration
options vary based on the external key vault you select.
Choose your integration method:
• Initial installation
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• Post-installation using key vault utility

On-Premises initial installation using AWS Secrets Manager
Using the initial installation method, you can connect and configure the external key vault connector,
service account credential (Active Directory master password), and bootstrap (database) credential
identifier.

Nota:  You must select Microsoft SQL Server Authentication as the database; other database
authentication methods are not supported for this use case.

You can configure the SMTP and AD credential identifier to retrieve from the external key vault using the
Automation 360 user interface.
1. Configure the AWS Secrets Manager requirements from the AWS Administrative Console.
2. Integrate the AWS Secrets Manager and Automation 360 Control Room.
3. Set up the authentication type for Automation 360 Control Room users and the AWS Secrets Manager.

After you successfully complete the initial installation, the Automation 360 Control Room can access and
retrieve credentials within the AWS Secrets Manager.
Configure AWS Secrets Manager requirements for initial installation
Before you can integrate the Automation 360 Control Room with the AWS Secrets Manager, you must
configure AWS Secrets Manager requirements using the AWS Administrative Console.
1. Use the AWS Administrative Console to collect these AWS environment variables which you must set in

the environment of the Control Room Server Microsoft Operating System:
• AWS_ACCESS_KEY_ID
• AWS_SECRET_ACCESS_KEY
• AWS_SESSION_TOKEN

2. After you set the environment variables in AWS, you must then add them to the Server Environment

on the Automation 360 Control Room:
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The AWS Secrets Manager has a flat name space with no organizational containers. There is no safe or
locker within the AWS Secrets Manager and all credentials are stored together in the same container.
Credentials are stored in objects which only have a secret name.
Integrate AWS Secrets Manager and Control Room
After you configured the AWS Secrets Manager requirements using the AWS Administrative Console, you
can integrate the AWS Secrets Manager and the Automation 360 Control Room.

1. After you start the Automation 360 installation wizard, select On-premises as the Deployment
Option and click Next.

2. Accept the license agreement and click Next.
3. Select Custom as the Installation Type Preference and click Next.
4. Accept the default locations for the destination folders and click Next.
5. To connect and configure the external key vault integration, select AWS Secret

Manager.
6. In the Region field, enter the AWS region code (for example: us-east1 and click Next.
7. Accept the default settings from the TLS Configuration dialog box and click Next.
8. Accept the default settings from the Service Credentials dialog box, and click Next.
9. From the Database Authentication dialog box, select an option to specify the Secret name from

AWS instead of manually entering the secret name the Control Room uses to authenticate to the

database.
a) Click SQL Server authentication (retrieve credential from external key vault), and then

enter the Secret Name value.
b) Click Next to continue and complete the initial installation. The installer will query AWS Secrets

Manager for the credential to validate that the secret exists.

After you successfully complete the initial installation, the Automation 360 Control Room can access and
retrieve credentials within the AWS Secrets Manager.
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Set up authentication type for AWS Secrets Manager
After you complete the initial installation and configure AWS Secrets Manager as the external key vault,
you can set up the authentication type for Automation 360 Control Room users in the Initial Setup (this
occurs directly after the initial installation completes).
1. From the Authentication type for Control Room users dialog box, click Active

Directory.
2. You can optionally configure the Active Directory integration credential (this is the credential that the

Control Room uses to authenticate users with Active Directory) to be retrieved from AWS Secrets
Manager. Click External Key vault and enter the AWS secret to retrieve credentials in the field (for
example: userAD). The Control Room will attempt to retrieve the credential from the AWS Secrets
Manager and then authenticate to the Domain Controller. If this fails either:
• There is no secret with that name in AWS Secrets Manager, or
• There is a secret with that name, but it does not contain a username and password that is

authorized for authentication with Active Directory.

3. Click Discover connections. The available domains and sites display.
4. Click Next and continue to create the Control Room first admin. Save the Admin user information.

You can now log in to the Control Room as admin and add users and roles.

On-Premises post-installation using AWS Secrets Manager
You use the command-line interactive key vault utility during a scheduled system downtime
and you must stop all running Control Room services. You should coordinate any key vault
configuration changes that might impact connectivity parameters (such as AWS_ACCESS_KEY_ID,
AWS_SECRET_ACCESS_KEY, and AWS_SESSION_TOKEN) during downtimes with the AWS administrative
team.

Nota:  If you use the key vault utility to disable AWS Secrets Manager integration, you must first unmap
any mapped credentials that are in use.

Using the post-installation method, you can perform these actions:
• Modify or configure the external key vault connection parameters.
• (If not configured during initial installation) Modify or configure the service account credential (Active

Directory master password).
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• (If not configured during initial installation) Modify or configure the database (bootstrap) credential
identifier (retrieved when authenticating the database).

Nota:  Retrieving bootstrap credentials from an external key vault might cause the Control Room to fail
if the external key vault is not accessible during boot-up, or if the external key vault is not accessible
when the Control Room refreshes database connections and authenticates users with Active Directory.

• Recover the Control Room for these reasons:
• By modifying the external key vault connection parameters, the service account, and database

credential safe and object identifiers.
• If AWS Secrets Manager connection parameters changes caused the Control Room to experience

connectivity issues.
• When credential identifiers for bootstrap passwords change.

You can address any initial configuration settings that were not set correctly and recover the system.

You can configure and edit SMTP and AD credential identifiers to retrieve information from the external
key vault from the Automation 360 Control Room by navigating to Administration > Settings > Active
Directory.
1. Run the key vault utility for the AWS Secrets Manager: To run the key vault utility and update

key vault connection settings:
a) As the Control Room administrator, access the Automation Anywhere Control Room installation

directory that was created during the initial Automation 360 installation.
Ad esempio: C:\Program Files\Automation Anywhere\Enterprise

b) Download the latest version of the key vault utility. To download the jar file used to update the
directory, open a browser and access the A-People site: A-People Downloads page (Login required).

Nota:  If DB authentication is configured to use external key vault, the utility returns the
following exception: Database currently configured to retrieve credentials
 from key vault. Update database authentication to WINDOWS/SQL to
 proceed further and exit.

The utility requests the user to confirm the action: Disable/update of key vault might
 impact functionalities using key vault (for example, Active Directory
 configuration, Email Settings configuration). Make sure to update these
 settings (if any). Are you sure you want to continue?

c) Enter Y to continue.
d) Enter the following:

> jdk11\bin\java -jar certmgr.jar -appDir . -importTrustCert <Full path
 of the certificate>

e) Add these jvm arguments to the command to run the key vault utility:
1. -Djavax.net.ssl.trustStore="C:\Program Files\Automation Anywhere

\Enterprise\pki\trust\store.ks"

2. -Djavax.net.ssl.trustStorePassword=changeit --module-path lib -
jar crutils.jar -configPath "C:\Program Files\Automation Anywhere
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\Enterprise\config" -action [UPDATE_KEY_VAULT_CONFIGURATION or
 UPDATE_DB_AUTHENTICATION_CONFIGURATION]

You can update either of these configuration actions:
• Enter UPDATE_KEY_VAULT_CONFIGURATION to edit the AWS Secrets Manager configuration.
• Enter UPDATE_DB_AUTHENTICATION_CONFIGURATION to change to database

authentication using external key vault.

2. Based on which configuration action you used, choose the appropriate action:
• Update key vault configuration for AWS: If you entered

UPDATE_KEY_VAULT_CONFIGURATION as the configuration action:
a. After the utility loads the current key vault configuration and properties, and this prompt is

displayed: Enter key vault [AWS/CYBERARK/AZURE/NONE] :, enter AWS
b. At the Please enter Vault URL: prompt, enter (for example): https://

services.uscentral.skytap.com:19516

The key vault utility runs. If the configuration was successful (the utility was able to connect to the
external key vault using the configured parameters), these messages are displayed on the console:

Connection configurations valid
  Key Vault configurations successfully updated

• Update database authentication for AWS: If you entered
UPDATE_DB_AUTHENTICATION_CONFIGURATION as the configuration action:
a. After the utility loads the current database configuration information, this prompt is displayed:

Database authentication configurations loaded
Currently configured database authentication [SQL]

Change database authentication. Available options:
WINDOWS: Connect to database using windows authentication
SQL: Connect to database using SQL server authentication, manually
 enter username and password
KEY_VAULT: Connect to database using SQL server authentication,
 retrieve username and password from external key Vault 

Enter database authentication [WINDOWS/SQL/KEY_VAULT]:

Enter KEY_VAULT
b. At the Please enter Secret name: prompt, enter (for example): testDB

The key vault utility runs. If the database configuration was successful (the utility was able to
connect to AWS, retrieve the designated credential and then use the credential to connect to the
database), these messages display on the console:

Database Credentials are valid
Database authentication configurations successfully updated
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Cloud integration using AWS Secrets Manager
For Cloud integrations, you can configure the Control Room and external key vault integration using the
Automation 360 Control Room user interface.
The Agent auto-login and Agent automation use cases are only supported on Automation 360 Cloud
Control Room instances. Neither of these use cases affect the Control Room boot sequence or Control
Room functionality.

Nota:  Bootstrap and service account credential retrieval use cases are not supported on Cloud Control
Room instances because the database and services are managed internally by Automation Anywhere.
There is no compliance use case (requirement) for these credentials to be stored in the customer external
key vault.

1. Gather the specific AWS information required to configure the external key vault connector using the
Automation 360 Control Room.

Elemento Descrizione

AWS_ACCESS_KEY_ID The AWS environment variable that specifies
an AWS access key associated with an IAM
user or role.

AWS_SECRET_ACCESS_KEY The AWS environment variable that specifies
the secret key associated with the access
key.

AWS_SESSION_TOKEN The AWS environment variable that specifies
the session token value that is required
if you use temporary security credentials
retrieved directly from AWS operations.

Regione A separate geographic area that AWS uses
to house its infrastructure.

2. Log in to the Automation 360 Control Room as the Administrator.
3. From the Control Room, navigate to Administration > Settings > External key vault.
4. Click the Edit icon to open the Configuration settings pane.
5. Click AWS and then enter the specific AWS information described in the preceding table.
6. Click Save changes to connect the external key vault.

AWS credential retrieval use cases
You can retrieve AWS credentials for these use cases: bootstrap, system, auto-login, and automations.

Retrieve Control Room bootstrap credentials

Nota:  This use case applies to On-Premises deployments only.

The Automation 360 Control Room uses bootstrap credentials to access supporting services such as
database, service account, and Active Directory (AD). You configure these credentials during the initial On-
Premises installation or post-installation (using the key vault utility) by specifying the object name.
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The following image shows the process of retrieving the Control Room bootstrap credentials with AWS:

When required during the bootup sequence or normal operations (such as refreshing a service
authentication), the Control Room uses the key vault connection to retrieve the credential and perform the
required authentication.

Nota:  You must select the Microsoft SQL Server Authentication for this use case; other database
authentication methods are not supported for bootstrap.

Retrieve Control Room system credentials

Nota:  This use case applies to On-Premises deployments only, and you can configure the service account
only during the initial installation.

If you configured an external key vault during the initial installation, you can then use the Automation 360
user interface (post-installation) to configure SMTP and Active Directory (AD) credentials.
1. Log in to the Automation 360 Control Room as the Administrator.
2. From the Control Room, navigate to: Administration > Settings > Email Settings.
3. You can map the AD Master Account credential from the external key vault, configure external

credentials, or set to manual (switch modes of AD Master Account credential retrieval).

Retrieve auto-login credentials

Nota:  This use case applies to both On-Premises and Cloud deployments.

Auto-login credentials are used to authenticate to an Automation 360 Bot Agent device and start an active
Windows session. Robotic Process Automation (RPA) requires an active Windows session to function. Auto-
login occurs prior to the automation running when automations are launched from a remote Bot Agent
device.
The following image shows the process of retrieving the auto-login credentials with AWS:
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A Control Room administrator can manually launch or schedule a job to launch an automation on a Bot
Agent device by specifying these details:
• Automation (bot) name
• Nome dispositivo
• User context

The system performs auto-login to the specified device with the user name and password associated with
the user context, and then runs the automation on the device.
You must have a secret for each Control Room user for whom the auto-login credentials will be retrieved
from the external key vault, and the secret name in the AWS Secrets Manager must match the Control
Room username.
To configure retrieval of auto-login credentials from the external key vault, perform these steps:
1. Log in to the Automation 360 Control Room as the Administrator.
2. From the Control Room, navigate to Administration > Settings > Devices.
3. Scroll down to the auto-login settings section and click Edit.
4. If you previously configured AWS Secrets Manager as the external key vault connection, click Enabled

to retrieve the auto-login credentials from that external key vault.
If this option is disabled, then the external key vault connection was not configured.

Nota:  If you disable auto-login from the external key vault, then credentials are retrieved using the
AAI Credential Vault and its stored credentials instead.

5. The AWS Secrets Manager has a flat name space without any organizational containers, so you do not
need to enter a Safe name. Fai clic su Salva modifiche.

If successful, then the auto-login settings successfully saved message displays.

Auto-login naming conventions

The Control Room retrieves auto-login credentials based on the object naming convention within the
external key vault. The Control Room searches for an object where the object name (the credential name
in the external key vault) matches the Control Room username for which it is performing auto-login.
The prefix autologin_ is required as part of the naming convention for auto-login credentials for all
external key vaults: CyberArk, AWS, and Azure. The name of the auto-login credential in the external key
vault must contain autologin_ followed by the Control Room username. In some cases, certain key
vaults have restrictions on the characters that can be used in credential object names. Additionally, to
support how different use cases encode credentials, Automation 360 requires that certain characters be
reserved or encoded.
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The following table lists examples of the object naming conventions expected in the Control Room:

Control Room username Expected object name format

ABCD\user123 autologin_ABCD--user123

user123@rpa.abcd.com autologin_user123-40-rpa-2e-abcd-2e-com

Nota:  For On-Premises customers using AD authentication, you must format auto-login usernames using
the UPN format or domain\username postfix.

For auto-login credentials, keep these in mind:
• The object name in the external key vault must contain autologin_ as a prefix.
• The auto-login credential names must map to the Control Room username (login ID) for the credential

being retrieved.
Some external key vaults have usage restrictions of certain characters, such as backslash (\) and
ampersand (@) in the secret name (object name), and restrictions on how special characters are
interpreted within API calls. If the user ID contains special characters, then you must encode the secret
name (object name) in the external key vault using ASCII code character substitutions, as listed in the
following table.

This character Changes to this ASCII code character
substitution

\ (backslash) --

- (dash) -2d-

_ (underscore) -5f-

@ (ampersand) -40-

. (period) -2e-

Nota:  Except for the backslash being mapped to double dashes, the dash, period, underscore, and
ampersand are mapped using their ASCII code bracketed in dashes.

AWS auto-login credential example

For this auto-login credential retrieval example, consider a Control Room user who wants to deploy a bot
on a device as a specific user. This example uses the following details:
• Automation (bot) name run on a device = ProcureToPayGeoEast
• Agent device name = WinVDI1138
• Agent user context = rpauserCR1@abcd.com

The following image shows this an example of retrieving auto-login credentials with AWS:
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Before starting the automation, ensure the following:
1. The Control Room connection details have been successfully configured, and the Control Room uses

these connection details to connect to AWS and performs authentication.
2. The Control Room queries the Bot Agent device running on device WinVDI1138 to check if there is

an active Windows (operating system) session currently on device WinVDI1138, and if that session
belongs to Agent user rpauserCR1.
If there is an existing session on the device for user rpauserCR1, then there is no need to perform
auto-login and the bot continues with the deployment.

3. However, if there is an no active session or if there is an active session that does not belong to
rpauserCR1, then the Control Room retrieves the auto-login credential from the AWS Secrets
Manager.

4. The Control Room passes the credential (password) to theBot Agent. The Bot Agent performs
a Windows login on device WinVDI1138 as rpauserCR1 (first, logging off any other
user login session) using the auto-login credential for rpauserCR1. The automation (Bot)
ProcureToPayGeoEast then starts to run on device WinVDI1138 as rpauserCR1.

Retrieve automation credentials

Nota:  This use case applies to both On-Premises and Cloud deployments.

Automation credentials are variables used by bot developers within automation (bot) actions that define
and retrieve data from encrypted storage. The automation uses the credentials to authenticate to
applications (for example: finance application). Automation credentials are retrieved by the Automation
360 Bot Agent during runtime.
The following image shows the process of retrieving automation credentials with AWS:
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Automation credentials retrieved from the AWS Secrets Manager are mapped in the Automation Anywhere
Credential Vault. The Credential Vault supports these two types of automation credentials:

System credentials Credentials where the value returned by the
credential variable is the same for any automation
that uses that variable.

User-defined credentials Credentials where the value returned by the
credential variable is distinct based on the user
context in which the automation is running.

For both system credentials and user-defined credentials, the bot developer specifies the same credential
variable within the bot code. Then, the system determines which credential to retrieve during bot runtime.
User-defined credentials simplify automation development by enabling bot developers to write code using
a single credential variable where the RPA platform substitutes the value returned during runtime with
a unique user-specific value. Developers can avoid writing duplicate code with different user-specific
credential variables.
The following image shows the expected naming convention for AWS credentials:

The diagram shows six secrets in the AWS Secrets Manager which can be mapped to two credentials
within the Control Room Credential Vault
• Object3
• Object4

For example, you can map a locker in the Control Room to either prefixID3 or prefixID4. Then, you
map the secret to a credential. For each credential, the secrets will be consumed (retrieved by the Control
Room) as a system-defined credential (without username postfix) and two user-defined credentials (one
each for the Control Room users whose usernames are User1ID1 and User1ID2).
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Nota:  Within the Control Room Credential Vault, the name of the locker and the name of the credential
are arbitrary and local to the Control Room. You map these names to specific secrets in the external key
vault.

Within AWS Secrets Manager, each automation credential is stored with a name that contains specific
identifiers including: a prefix, object identifier, and an optional postfix which identifies a username. This
is a required naming convention that assures retrieval of the correct credential. The name of the secret
(the credential) in AWS Secrets Manager encodes information about the mapping within the Automation
Anywhere Credential Vault.
As an administrator, to map a Control Room to AWS Secrets Manager, you create and configure a locker
and a credential using the external key vault option within the Create Locker and Create Credential
features in the Automation 360 Control Room:
• You configure lockers in the Credential Vault that map to an AWS secret name prefix.
• You configure credentials in the Credential Vault that map to an AWS secret object identifier (optional

postfix for user-defined credential).

During runtime, the RPA platform retrieves the secret that is named with a postfix that matches the user
context (user-defined credential) in which the automation is running. If there is no user-defined credential,
then the RPA platform retrieves the secret without a username postfix (system credential).
The Control Room implements access controls to the external credentials through permissions within roles.
You control access to credentials by assigning different Control Room users to different roles and then
associating different lockers with those roles.
The following image shows the Control Room Credential Vault locker and credential mapped to an AWS
secret:

Importante:  When creating an externally mapped credential, you must place the credential in the
appropriate externally mapped locker (the locker is mapped to the prefix in the secret name). The AWS
secret name will have a naming convention: Prefix + Secret_Name_Body + Postfix (optional for
user-defined credentials).

Nota:  The same permissions and privileges (assigned through roles) in the Control Room apply to
credentials mapped to the external key vault.
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Automation naming conventions

The following table shows AWS Secrets Manager external key vault examples using naming conventions for
automation.

Nota:  The AWS Prefix maps to the locker for the Control Room, and the AWS Secret Body maps to the
credential for the Control Room.

Automation
credential
example

AWS Prefix AWS Secret Body Secret in AWS Control Room
username

accounting_pdf
System credential
in locker mapped
to AWS Secret
name prefix
accounting

accounting pdf accounting_pdf
(system)

None - system
credential

accounting_pdf_ABCD--
user123
User-defined
credential in
locker mapped
to AWS Secret
Name prefix
accounting

accounting pdf accounting_pdf_ABCD--
user123

ABCD\user123

AWS automations credentials retrieval example

To configure automation credentials retrieval and integrate with the AWS Secrets Manager, you first create
a locker and then create credentials.
To create a locker to integrate with the AWS Secrets Manager, perform these steps:
1. From the Automation 360 Control Room, navigate to Manage > Credential.

A user with Manage my credentials and lockers permissions is authorized to create credentials.
2. From the Credentials tab, select Create Locker.
3. Enter a name for the locker (for example, Locker3).

This name is local to the Control Room and does not have any dependency on the AWS secret name.
4. Click External Key Vault and enter the AWS secret name prefix (for example: prefixID3). You

must name secrets within the AWS Secrets Manager using the name prefix for the configuration of the
mapping to complete successfully.

5. Fai clic su Avanti.
6. Configure Owners, Managers, Participants, and Consumers for the locker.
7. Click Create locker.

Consulta Crea locker alla pagina 2844.
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The Control Room is now ready to retrieve credentials and enforce access controls on all Azure secrets with
the prefix prefixID3. To continue, you now create the credentials.
To create a credential to integrate with the AWS Secrets Manager, perform these steps:
1. From the Automation 360 Control Room, navigate to Manage > Credentials.

A user with Manage my credentials and lockers permissions is authorized to create credentials.
2. From the Credentials tab, select Create Credential.
3. Enter the credential name in the Credential name field.

This name is local to the Control Room and does not have any dependency on the AWS secret name.
4. Click External key vault below the name field.
5. From the list of available lockers, select the appropriate locker that was previously mapped to the

secret name prefix for the secrets you are now mapping to the credential.
6. Enter the AWS Secret_Name_Body in the Secret name field (for example: Object3).
7. Click Validate and retrieve attributes.

The system validates the mapping by attempting to retrieve from the AWS Secrets Manager a secret
with the name Prefix_Secret_Name_Body (for example: prefixID3_Object3.
If validation fails, then no secret exists in the AWS Secrets Manager with the name that matches the
combination of locker (prefix) and credential (Secret_Name_Body). In this example, there is no
secret in the AWS Secrets Manager named prefixID3_Object3.
When the system successfully retrieves the secret, it will display the AWS Secrets Manager secret
attributes (the fields within the secret).

8. From the list of attributes, select attributes to map to the credential.
9. Click Create credential.

If successful, then the credential successfully created message displays.

Changing external key vault to another
If you did not integrate the external key vault during the initial installation and you want to configure it
without re-installing, you must use the key vault utility. Also, to change the external key vault connection
details or to change the bootstrap credentials, you must use the key vault utility.
You use the key vault utility for each of these scenarios:
• To initially configure the external key vault connection if it was not configured during initial installation

and you do not want to re-install the external key vault.
• To change external key vault connection details:

• Example 1: CyberArk Password Vault is migrating to a server with a different name
• Example 2: CyberArk Password Vault authentication certificate is changing
• Example 3: You want to change from one AWS Secrets Manager instance to another
• Example 4: You want to change from one Azure Key Vault instance to another

• The Automation 360 Control Room is malfunctioning because the external key vault connection has
changed, and the Control Room is no longer able to retrieve credentials from the external key vault.

• The Control Room is malfunctioning because the credentials defined for bootstrap or Active Directory
integration have changed names.
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• To change the KEY_VAULT from one external key vault to another, or to NONE, you must first manually
set the database and service account credentials that are currently being retrieved from the external
key vault.
For example, to change from an AWS Secrets Manager key vault to a CyberArk Password Vault, you
must perform these actions:
1. Set the external KEY_VAULT attribute to NONE.
2. Set the external key vault to the new key vault type.

This following table provides guidelines on acceptable state changes for the KEY_VAULT attribute:

Original key vaultNew key vault

AWS CyberArk Azure Nessuno

AWS Sì No No Sì

CyberArk No Sì No Sì

Azure No No No Sì

Nessuno Sì Sì Sì Sì

• To change from an AWS Secrets Manager key vault to a CyberArk Password Vault (or vice-versa), you
must first change the KEY_VAULT attribute to NONE.

• To change an AWS Secrets Manager key vault or a CyberArk Password Vault to NONE, ensure that the
database is not connected with the KEY_VAULT attribute.

Verify external key vault configuration
Use the Automation 360 Control Room to verify external key vault configuration and database
authentication changes you made using the key vault utility.
1. Log in to the Automation 360 Control Room as the administrator.
2. Go to Administration > Settings > General > Configuration settings.
3. Go to the Control Room Database & Software tab and scroll down to the Control Room database

information to verify its details.
4. Navigate back to Settings > External key vault and review its configuration settings for external

vault, vault URL, and Application ID.
5. Navigate back to Settings > Email, and click the Edit icon to open the Notifications pane.
6. Scroll down to verify that the external key vault settings reflect the SMTP credential identifier in the

external key vault
7. Fai clic su Chiudi.

Troubleshooting external key vaults
You can use the keyvault.properties file and application log files to review configuration and
integration information for external key vaults.
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Use the keyvault.properties file

You can use the keyvault.properties file to review configuration attributes for these external key
vaults:
• CyberArk Password Vault
• AWS Secrets Manager
• Archivio chiave Azure

The following keyvault.properties file shows an example with the CyberArk Password Vault:

To review the AWS Secrets Manager keyvault.properties file, enter these AWS attributes (for
example):
• keyvault.type=AWS_SECRETS_MANAGER
• keyvault.aws.region=us-west-2

Nota:
• The certificate passphrase attribute contains the encrypted Control Room certificate file passphrase. Do

not modify the certificate passphrase attribute directly; instead, you should use the key vault utility.
• You can modify the keyvault.properties file. However, any modifications will require a service

restart. So we recommend that you always use the key vault utility to make modifications.

Use the application log files

You can use these application log files to review external key vault integration information:
• WebCR_CredentialVaultlog
• WebCR_RestException

You can use these log messages to troubleshoot external key vault integration or configuration issues:

Log message description Cause or reason

Unable to send an email
Impossibile connettersi al server SMTP perché
il nome utente o la password SMTP non sono
corretti

Retrieved SMTP credential is incorrect.

Logs indicate failure connecting to LDAP Failure to authenticate through Active Directory.

WebCR.log file shows database connectivity
error, and the Control Room fails to boot up
correctly

Retrieved database password is incorrect.
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Log message description Cause or reason

Either your username or your password is
incorrect

Retrieved auto-login credential is incorrect for
the user (correlates to the bot deployment log
for user ID).

Logs indicate connection failure to CyberArk A possible certificate expiry issue exists if failure
occurs after a period of proper functioning for (3,
6, or 12) months.

A non-existent credential identifier (safe name,
object name, or secret name) is in use. Might
also indicate the credential identifier was
removed from the external key vault (if it was
previously working properly).

Unable to retrieve secret, and detail exception
will have cause

Might also indicate that the key vault connection
is down or unreachable. Or, connection details
(API URL, AppID, certificate, region name, AWS
keys) are incorrect, have been changed on the
key vault, or expired.

Notifiche
Notifications is a built-in mechanism in the Automation 360 Control Room, which notifies users about
various events. It is a centralized notifications repository in Automation 360 for all users to track relevant
events.
The Notifications mechanism provides simplified information about possible risks, warnings, information,
and success statistics of the Automation 360 platform and automation events. With the notifications
feature, you can monitor, respond, reduce, and resolve critical risks in much quicker way. It allows you
enable required event categories and be notified for the enabled events.
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Vantaggi

Notifications provide the following benefits:
• Maintain all the notifications from a centralized repository.
• Enhance ability to respond to critical or warning notifications.
• Stay organized with automated notifications to reduce and avoid future risks, and take possible actions.
• Improve productivity of users and the platform by being notified about updates such as Bot export and

add or update package.
• Save time and increase notification efficiency because of a single centralized events repository.
• Increase relevance of notifications delivery through multichannel communication.
• Notify Automation 360 users about events through email report or instant email notification.

See the following video for an overview of how notifications are configured in the Automation 360 Control
Room:

Prerequisiti

• The Control Room administrator must enable the Administration > Settings > Notification
settings to receive notifications. Per ulteriori informazioni, consulta Administer notifications for Control
Room alla pagina 2923.

• Control Room users must enable the required settings from the Notifications repository to receive
notifications. Per ulteriori informazioni, consulta Enable or disable event categories alla pagina 2924.
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Componenti

• Notification icons and navigation:
•

: Indicates no new notification.
•

: Indicates new notification.
•

: Indicates hover over action on the notification icon.
•

: Indicates select action on the notification icon.

• Notifications panel:
The in-app notification panel provides a comprehensive view of all the event notifications with
notification summary and details. Per ulteriori informazioni, consulta Getting started with Notifications alla
pagina 2915.

• Severities:
The in-app notification panel displays and categorizes all notification information in the following
severities:

Critico Notifies about high-risk events, which can stop or
impact execution of scheduled tasks or processes.

Attenzione Notifies about cautionary events, which can
be interrupted, not running as expected, or
completed with minor recoverable errors.

Informazioni Notifies about platform or functionality updates,
such as updates to packages and bot export.

Operazione riuscita Notifies about events that are completed
successfully.

• Settings:
Enable and disable the notifications for Automation runtime events and Platform events. You can
also enable Email report channel to receive notifications through email.

Getting started with Notifications
The notifications repository provides simplified information that users can track for possible risks, warnings,
and success statistics of various Automation 360 events.
When you enable required event categories, you receive notifications through the notifications repository.

New notifications display with the ( ) icon.
To start working with notifications, set preferences for the following event categories and notification
channels:
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Event categories

Events are at the core of the monitoring framework. Users must be able to monitor event continuously,
and receive constant notifications. Automation 360 provides notifications for the following events:

Automation events This category notifies you about bot-related events.
These event notifications are sent to users based
on the permissions defined in the Automation 360
platform, and those users who have performed
specific tasks, such as export bot.
The following table lists examples of the automation
event and its severity:

Event
name

Severity Users
notified
for the
event

Type of
email
notifications

Bot export
successful

Operazione
riuscita

Control
Room
user who
exported
the bot

Email
report

Bot export
unsuccessful

Critico Control
Room
user who
exported
the bot

Email
report

The following example shows an export bot event
notification with the Success severity:
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Platform events This category notifies you about events related
to the Automation 360 updates. These event
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notifications are sent to users based on their role
and permissions defined in the Control Room.
The following table lists an example of platform
events and their severity:

Event
name

Severity Users
notified
for the
event

Type of
email
notifications

Add or
update
package

Operazione
riuscita

All Control
Room
users

Email
report

Notification channels

Notifications are sent through integrated channels used to organize and manage the notifications.
Automation 360 send notifications through the following channels:

Notifications panel This is the default notification channel. The
notifications panel provides a summarized view of
all event notifications. It categorizes notifications
based on severity, and then sorts them in each
category by date showing the most recent
notification first. The count on each severity tab
(Critical, Warning, Info, and Success) shows
the number of unread notifications. Per ulteriori
informazioni, consulta Notification summary and
details alla pagina 2920.

Nota:  These notifications are available in the
Control Room for maximum of seven days.

Email notifications These notifications generate emails to the opted-
in users only. There are two types of email
notifications:
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• Instant notifications: Instant email
notification is sent to a user's registered email
address.
The following sample shows an email sent for an
instant notification:
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• Email report: Email report notification is sent
to a user's registered email address twice a day
at a fixed time.
The following sample shows an email sent for an
email report:

Nota:  Notifications that are sent as Instant
notifications are not included in the Email
report and vice-versa. Based on the event
type, notifications are sent either as Instant
notifications, or Email report. You cannot
configure these notifications.

Notification summary and details

After you enable the required event category, corresponding event notifications are sent through the
Notifications repository. By expanding the notification summary, you can view the notification details.
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Nota:  Every event notification does not have notification details. Sometimes the notification summary
provides all of the event information, for example, notifications about package updates with the Info
severity.

The following image is a sample event notification with Success severity:
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The following table describes the fields in the sample event notification (as numbered in the previous
example):
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Field/Option Descrizione

1 Event severity

2 Notification summary

3 Notification details

4 Event description

5 Exported or archived file name

Nota:  This field and description varies based on the event severity.

6 Event start date with time stamp

7 Event end date with time stamp

8 Message that describes the root cause of the event and next
possible action (if applicable) to take

Nota:  The notification summary and details information varies based on the event type and severity.

Administer notifications for Control Room
As an administrator, you can manage notifications for the Control Room by enabling various notification
categories and channels.
Login to Control Room as an administrator.
You can manage notification settings for all the Control Room users and view the audit log information to
track user activities.

Nota:  All the event categories are disabled by default.

1. Navigate to Administration > Settings > Notification settings.
2. To enable or disable the required event categories, click Edit.
3. Enable the required event categories. For more information about which event category to enable, see

Event categories alla pagina 2916.
4. Fai clic su Salva modifiche.

Nota:  Notifications audit logs to track user activities are available at the Administration > Audit
log page. Per ulteriori informazioni, consulta Log di audit alla pagina 2654.

Manage notification channels
As a Control Room administrator, you can manage notification channels through which you want to notify
all the Control Room users.
• Login to Control Room as an administrator.
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• For On-Premises users, navigate to Administration > Settings > Email and enter an email address
in the From this email address field to manage emails. Per ulteriori informazioni, consulta Modifica
notifiche via e-mail alla pagina 2750.

Nota:  This setting does not apply to Cloud users. The region-specific email addresses deliver the
notifications in their respective clouds.

After you enable the required event categories, enable the required notification channel through which
Control Room events are notified to the opted-in users. This feature helps you to notify users through
email about events such as a planned maintenance activity. It is useful when you have a dedicated support
team for managing the RPA operations.

Nota:  The email channel is disabled by default.

1. Navigate to Administration > Settings > Notification settings.
2. Click Edit to enable or disable the required notification channel.
3. Enable the required notification channel. For more information about notification channels, see

Notification channels alla pagina 2918.

Nota:  Notification channels enabled by an administrator are applicable to all the Control Room users.

4. Specify the email address or email distribution list to whom you want to send the email report.

Nota:
• You can specify multiple email addresses and email distribution lists separated by comma.
• You can send an email notification to a specific email distribution list.
• You cannot send email notifications to public domain addresses such as gmail.com, yahoo.co.in,

and so on.

5. Fai clic su Salva modifiche.

Enable or disable event categories
As an individual user, you can enable or disable the required events categories to receive notifications, and
control notifications traffic in your Control Room instance.
Ensure that the required event category is enabled by Control Room administrator.

1.
Click the Notifications ( ) icon.

2.
Click the Settings ( ) icon in the Notifications window.

3. Enable the required event category and close the Notifications settings window. For details about
which event category to enable, see Event categories alla pagina 2916.

Nota:  The Control Room administrator manages the disabled event categories.

Enable email report channel
As an individual user, you can use the email report channel to notify Control Room users about various
events through emails.
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Ensure that the required email report channel is enabled by Control Room administrator.
Email notifications are sent as an instant notification or email report based on the event severity identified
by the Automation 360 platform. The email report channel is disabled by default.
1.

Click the Notifications ( ) icon.
2.

Click the Settings ( ) icon in the Notifications window.
3. Enable the Email report option to receive email notifications.

An email report, containing the Control Room URL and time duration when the report was generated,
is sent to the specified email addresses or email distribution list.

Nota:  When you enable the email report channel, consider the following information:
• If the Control Room administrator does not enable the Email report channel, then individual users

cannot enable or disable this option. As a result, individual users cannot be notified through emails.
• If the Control Room administrator disables the Email report channel for a certain duration (for

example, maintenance activity over weekend), individual users cannot receive email reports for
that duration.

• The email report is sent to all email addresses and distribution lists specified by the Control Room
administrator based on the enabled event categories.

• If an event is critical and marked for instant notification, then an email notification is sent
immediately when the event occurs. Otherwise, it is sent as a part of the email report but the email
notification not included in both instant notification and email report.

• A single email report is sent for all bot events.
• An email report is sent twice a day, at a fixed time that is 8 AM (PST) and 4 PM (PST).

Capabilities supporting notifications
With Notifications, you are notified about specific events in Automation 360, such as bot execution tasks
and updates to platform and functionalities.
Automation 360 supports notifications for the following capabilities:

Esporta bot

When a bot is exported, you are notified about this automation event. Based on the result (success or
failure) of the export bot functionality available in the platform, you receive a notification that contains the
event details and severity level (Critical, Warning, Info, or Success). This notification is sent only to the
user who exported the bot.

Add or update package

When a package is added or a new package version is released in the Control Room, you are notified
about this platform event. This notification is sent to all the Control Room users who have the View
package permission. Based on your role and package permissions, you can view event notifications. For
package versions information, see View package versions available in the Control Room alla pagina 2009.

Nota:  For custom packages, a notification is sent only to the corresponding customer and not to all the
Control Room users.
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Edit My settings
The My settings page provides user profile specific information.

Il mio profilo

Each RPA user is required to have an active profile in the Control Room to built, run and schedule the
deployment of bots as well as for security authorization. Profile information includes user names, email
addresses, passwords, and so on.
To access this information, click the My Settings navigation tab.
The My Settings page displays an expandable My profile tab that shows specific and configurable user
details. Click the Edit icon to update this profile information.
Attività correlate
Edit profile settings alla pagina 2926
Update your user profile settings in the Control Room.

Edit profile settings
Update your user profile settings in the Control Room.
Ensure that you are logged in to the  as the administrator.
Each RPA user is required to have an active profile in the Control Room to built, run and schedule the
deployment of bots as well as for security authorization. Profile information includes user names, email
addresses, passwords, and so on.
1. Navigate to My Settings.

The My Settings page displays the expandable My profile tab for specific and configurable user
details. Click the Edit icon to update this profile information.

2. Update any or all of the general details for your profile.
Opzione Descrizione

Nome Maximum character length is 50.

Cognome Maximum character length is 50.

E-mail di contatto Maximum character length is 255.

Cambia password 8-15 characters: a-z (lowercase), A-Z
(uppercase), 0-9, and the following special
characters are allowed: @, -, _, !, #, $, %, ., and
&

3. Fai clic su Salva modifiche.

CoE Manager
Automation Anywhere CoE Manager helps you achieve visibility into your end-to-end automation lifecycle
while accelerating the pipeline generation. It helps scale the automation programs more quickly and
efficiently, while maximizing the value realization from the investment in your automation program.
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CoE Manager is available out of the box and requires minimal configurations for first-time use. In addition
to program management capabilities, it provides a consistent and repeatable way of assessing automation
opportunities in order to minimize variations and maximize return on investment (ROI). ROI can be
measured in terms of time and cost saved as well as user-defined KPIs such as operational agility, cash
flow, sustainability, and so on.
CoE Manager is powered by Shibumi platform, a leading provider of enterprise program management
solutions.

Vantaggi

CoE Manager helps you in the following ways:
• Scale automation programs more quickly and efficiently.
• Forecast business results, identify metrics for success, and track them through the entire automation

lifecycle.
• Create single view of portfolio status, risks, and interdependencies.
• Informed decision making with timely and accurate data.
• Assess all automation ideas across expected savings, strategy alignment and automation complexity to

enable prioritization.
• Reduce manual effort on multi-level tracking, computing, and reporting.
• Maximize the value (ROI) from your automation investment.
• Boost the value of the pipeline of automation opportunities to build the business case for additional

investment.

Capabilities

CoE Manager is a cloud-based platform which helps manage the automation pipeline and delivery.
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Key capabilities of CoE Manager are:
• Accelerate the automation lifecycle journey with a purpose-built automation CoE management solution

where everyone can share automation ideas.
• Enable the leadership team to make focused decisions by providing dashboards that help maximize the

ROI from the automation program.
• Enable tracking and managing the pipeline by tracking automation program data, set targets, and

tracking the progress. It helps manage the pipeline from idea to delivery to value realization.
• Track automation ROI via native integration with Automation Anywhere.
• Seamless reporting via dashboards and automated report creation.
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• Efficient governance with role-based access control with in-built approval workflows and user
notifications.

Componenti

The CoE Manager includes the following components:
• Dashboard: Provides graphical insight to help you view the adoption and progress of the automation

program. It displays information on idea velocity, opportunities by stage, forecasted savings versus
program target, value by stage, as well as benefits at various stages.

• Opportunities: Displays all opportunities across idea, pipeline, in-progress, and deployed stages.
• Ideas: Displays new opportunities submitted into CoE Manager.
• Pipeline: Displays approved opportunities.
• In Progress: Displays opportunities currently in design/build stage.
• Deployed: Displays opportunities that are live.
• Risks: Track program risks and their resolutions.
• Reporting: View and export the status of entire automation program or drill-down into each business

unit.
• Admin: Configure program details and targets, questionnaire and weightages, cost estimates, benefit

types, and so on.

Getting started with CoE Manager
CoE Manager provides clear visibility into the backlog of automation ideas, their position in the lifecycle,
and how much value they will deliver back to the business. The following is a high-level overview of how to
get started with CoE Manager:
Add the following email domains to your email client's safe-senders list to ensure users receive the
notifications generated by CoE Manager.
• APP environment (North America) - notifications come from @mail.app.shibumi.com
• EU environment (Europe and India) - notifications come from @mail.eu.shibumi.com
• AP environment (Asia-Pacific) - notifications come from @mail.ap.shibumi.com

Administrator
• Configure your CoE Manager for first-time use: CoE Manager provides program-level administration tabs

to tailor the solution for your use.
Configuration instructions for admin

• Add users: Add participants to specific roles within your CoE Manager.
Add users

• Register and access CoE Manager: You must be invited to use CoE Manager. When you respond to your
first invitation, you will set up a login account. You will use this account for all future use.
Creating and managing your account

• Link Control Room: Link up to three Control Room in your CoE Manager.
Integrate CoE Manager with Control Room alla pagina 2931

• Customize your CoE Manager: The CoE Manager provides several program-level administration tabs to
tailor it as per your requirement.
Customize the CoE Manager alla pagina 2932

• Register a digital worker within the CoE Manager: You can review digital worker information from the
Deployed tab and add automations directly on an opportunity. To register a digital worker with an
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opportunity, you can either use the Opportunities tab to search for the opportunity you would like to
update or use the search option (magnifying glass icon) on the Navigation Sidebar.

Once you navigate to the opportunity, you can update the information on the Execution Tracking tab.
This tab is only available for opportunities that are in-progress, deployed, or completed.

To create an automation process, click the blue plus button displayed at the top right of the automation
processes list. Enter the name and automation ID. After creating the process, you can add the cost per
failure.
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Nota:  The Automation ID is same as Bot ID from Automation Anywhere (see example below).

Once a process is created, the associated KPIs will be displayed in the execution metrics section.
Any user
• Create and manage opportunity: Submit an opportunity, build a business case for it, and track its

progress through the approval stage gates.
Create and manage opportunity

Integrate CoE Manager with Control Room
You can integrate the CoE Manager with the Control Room to monitor your automations and calculate the
savings achieved. You can link up to three Control Room instances with one instance of CoE Manager.
To link a Cloud Control Room to the CoE Manager, follow the steps mentioned below.
1. Create a custom role with the following permissions:

• View everyone's activity
• Genera chiave API

2. Create a user and assign the custom role created above.
3. Generate API Key for the user.
4. Log in to the CoE Manager by providing your Email Address and Password.
5. Navigate to Admin-Tech tab.
6. Click the placeholder URL in the Automation Anywhere URL column.
7. Click Edit in the Automation Anywhere URL field and enter the Control Room URL.
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8. Enter the username in the Automation Anywhere Username field.
9. Enter the API key in the Automation Anywhere API Key.
10. Fai clic su Salva.

The Enabled column automatically changes to Yes when you save the URL, username, and API key.

Customize the CoE Manager
The CoE Manager provides several program-level administration tabs to customize it as per your
requirements. You must have an admin role to customize the CoE Manager.

Admin - Program

In the Admin – Program tab, you can configure general settings for the overall program.

Program Details
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Opzione Dettagli

Program Start
and End Dates

Displays the start and end
dates for the program.

Currency
Symbol

Displays the currency symbol
alongside savings values.
This setting applies to all
opportunities.

Primary Benefit
Measure

Displays the primary
quantitative measure for the
CoE Manager as either hours
or currency. For example,
if you select currency, the
program dashboard tab
displays forecasted savings
on the top-left corner of the
page. If you select hours,
the program dashboard tab
displays the forecasted hours
saved.

Formato
numerico

Controls how large numbers
are abbreviated. The options
are full number, thousands, and
millions.

Number Suffix Automatically assigned based
on the number format selected,
has a value of K for thousands
and M for millions.

Formatted
Decimal Places

Specifies how many decimal
places to display in numbers
formatted with M or K based on
the number format selection
described above.

Assign Intake
Submitter as
Opp Owner

Determines whether the
system should create an
account for the user submitting
the opportunity. This is
applicable for users who
currently do not have an
account with the CoE Manager.
If set to Yes, the email address
in the opportunity submission
form is used to create the user
account. Ensure the email
domain is whitelisted within the
CoE Manager.

Track Program
Risks

Specifies whether or not to
show the risks tab at the
program level.
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Opzione Dettagli

Show Opp
Activities As

Specifies how opportunities
activities are displayed on the
activities tab. You can choose
between a List and a Gantt-
Chart.

Opp Target –
Overall Score
Calculation

Choose whether you want
to use amount or hours to
calculate opportunity targets.

Opp Target –
Amount and
Hours Saved

Specifies the target amount
and hours saved for individual
opportunities. For calculating
the Overall Score for an
opportunity, the percentage
achievement toward these
targets as well as the business
alignment percentage is used.

Weighted Benefit per Stage

Determines the weightings to calculate the
weighted benefits for opportunities at each stage in
CoE Manager. The weighted benefit is calculated by
multiplying the estimated value for each opportunity
with the corresponding factor to reflect the
confidence of the benefit being achieved. Typically,
opportunities in the idea stage are weighted lightly
and gain in weighted value as they progress toward
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deployment. The weighted value is used to estimate
total program savings.

Colors Specifies the hexadecimal color codes to use for
highlights in the system. The alert color is applied
when highlighting severe issues, the warning color
is applied when highlighting developing issues, and
the normal color is applied for normal operations.
The neutral color is applied as a default color in
non-alert situations.

Advanced Views Sets the visibility of the admin tabs. Per ulteriori
informazioni, consulta:
• Admin - Advanced alla pagina 2937
• Admin - Users alla pagina 2935
• Admin - Tech alla pagina 2936 | Integrate CoE

Manager with Control Room alla pagina 2931

Complexity Cost Estimates Specifies the default implementation cost estimate
to be assigned for an opportunity when either a
low, medium, or high complexity assessment is
specified for that opportunity. You can override the
default cost estimate by typing a new value in the
implementation cost field on the details tab for the
opportunity.

Business Unit List and Opportunity Sources Lists the business units and opportunity sources for
the automation program. Use the Create Business
Unit and Create Opportunity Source buttons at the
top of the section tabs respectively to create the
business unit and opportunity sources.

Monthly Targets Lists the program and business unit targets. You
can enter the targets for the program as a whole
and individual business units in this list.

Admin - Users

In the Admin - Users tab, you can manage role assignments on individual opportunities.
Opportunity Role Assignments
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Displays the list of opportunities and their participants along with the role of the participant (owner, admin,
or collaborator) in that opportunity.

Admin - Tech

In the Admin - Tech tab, you can manage the integration of automation platforms for the program.
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You can integrate up to three Cloud Control Room instances with the CoE Manager.

Admin - Advanced

In the Admin - Advanced tab, you can define the detailed prompts for additional benefits, complexity
and strategic alignment questions for automation opportunities. You can also specify the display icons
across the CoE Manager.

Label Settings You can change the labels for workstream,
complexity and strategic alignment attributes in the
details section of an opportunity.

Opportunity - Addl Benefit Types Defines up to five categories of benefits in the
additional benefits section on the details tab for
opportunities. You can track benefit amounts
and comments for each benefit category for the
opportunities.

Opportunity - Complexity Defines up to five complexity questions, weighting
for each question and the scoring scale. You can
rate each opportunity on a scale from none to very
high to drive a complexity score (based on the
weightings) for the opportunity.

Opportunity - Strategic Alignment Defines up to five strategic alignment questions and
the weighting for each question. You can rate each
opportunity on a scale from none to very high to
drive an alignment score (based on the weightings)
for the opportunity.

Icon Preview CoE Manager comes preconfigured with the
preferred icons and color schemes. You can
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customize these using Font Awesome icons to
highlight key measures for individual opportunities
as well as aggregated information. The Browse
Icons button allows you to browse Font Awesome
icons on their website. The Icon Preview entry
loads the specified Font Awesome icon (based on
an icon ID from the Font Awesome website) in the
panel to the right.

Icon Assignment Defines the icons to be displayed throughout CoE
Manager by using Font Awesome icon IDs from the
Font Awesome website.

Export and Import You can bulk import opportunities into a program.
Click the Export button to download the
opportunity template. This is a pre-filled template
with existing opportunities in the CoE Manager. To
add new opportunities, follow the below steps:
1. Open the downloaded template and delete the

existing data.
2. For each row of new opportunity to be created,

enter the data as outlined below:
• Column A: Default to Opportunity_t
• Column B: Do not fill
• Column C: Enter the Business Unit for the

opportunity being created
• Column D to AE: Fill the details as required

3. Save the excel file.
4. Click the Import button.
5. Browse and select the file and click Import.

Configure CoE Manager for Single Sign-On (SSO)
Use the SSO option to enable the CoE Manager authentication through an identity provider (IdP) using
Security Assertion Markup Language (SAML) 2.0 protocol.

SAML SSO login setup

Before configuring the CoE Manager, ensure you have completed the following requirements:
1. Download the Service Provider (SP) metadata for your respective CoE Manager region using the links

provided below:
• US environment: Test | Prod
• EU environment: Test | Prod
• AP environment: Test | Prod
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2. Configure your Identity Provider (IdP) with the metadata obtained from the previous step and in SAML
assertion, provide the following:
• Email, First Name, Last Name, and NameID
• Redirect URL for IdP-initiated login as a relay-state parameter

3. Provide the IdP metadata and the attribute names received from IdP (Email, Last Name, and First
Name) to the Automation Anywhere support team.

Login workflow

SAML SSO login can be configured using one of the following methods:
• Service provider-initiated login: The SP-initiated login starts with the CoE Manager and is triggered

when a user attempts to access the application through a URL. SP-initiated login requires a redirect to
the appropriate IdP to ensure proper authentication before access is granted to the service or to any
specific object. Depending on whether SSO is configured as mandatory or optional, your login workflow
will vary. See below for more information.
• Mandatory SSO: After SSO is enabled, enter your email address in the CoE Manager login page

and click Next.
As the CoE Manager is a multi-tenant application, you must use an email address to determine
the IdP to be redirected to. This email address can be from any domain associated with your
organization. CoE Manager will redirect to the IdP based on the entered email domain. For example,
if your organization is Acme Corp, you might have acme.com and acmeent.com as associated
domains. In this event, any address with @acme.com and @acmeent.com will redirect to the IdP
when you click Next. You will be redirected back to the CoE Manager page after IdP authentication.

• Optional SSO: On the login page, enter the email address and click Next. Instead of being
automatically redirected to the IdP, you will be prompted to either enter a password or select the
option to log in with SSO, which will be sent to your IdP for authentication.

Nota:
• CoE Manager supports deep linking with SSO. After clicking the link, you should enter your email

address in the CoE Manager login page. You are then redirected to the IdP for authentication. After
authentication, you are redirected to the URL initially requested.

• CoE Manager creates a cookie after successfully logging in to the application using SSO. This
ensures the subsequent logins to CoE Manager will bypass the username and password screen
and redirects to the appropriate SSO login page automatically. You can also override the cookie by
navigating directly to the CoE Manager login page, that is https://<region>.shibumi.com/
shibumi/login.

• A user account is automatically created after successfully logging in to the CoE Manager using SSO
for the first time.

• IdP-initiated login: With IdP-initiated login, you can access the CoE Manager directly through the
IdP (without a login page being displayed). When CoE Manager is launched using this method, you
are taken directly to your organization's CoE Manager home page or to a URL provided by the IdP as a
relay state parameter.
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Account provisioning

CoE Manager provisions user accounts as needed for organizations with enabled SSO. Accounts are
generated when:
• A user is assigned a role on an object in CoE Manager
• A user is invited to a CoE Manager work item
• A user first attempts to access CoE Manager

The typical account provisioning sequence would be for a user to be invited into a work item in CoE
Manager by an existing user. This triggers the auto-provisioning of their account. If this is not done,
when the user attempts to access CoE Manager the first time the account is provisioned, the user will not
have access to any work items. This can be a confusing experience. Therefore, it is a recommended best
practice to ensure that the users are invited to participate in a work item prior to the first access.

Nota:  User accounts are not imported in bulk from the IdP. Users are not automatically added or removed
from the CoE Manager instance when a person joins or leaves the organization.

When a user is authenticated via an IdP, their first and last name are updated in CoE Manager to reflect
the attribute values supplied in the SAML payload (the mapping of first name and last name to attributes is
part of the SAML configuration in CoE Manager and in IdP).

Using CoE Manager
CoE manager provides a structured and consistent way of assessing all submitted opportunities, thereby
increasing confidence in the quality of automation pipeline.

Work item basics CoE Manager is composed of Opportunities,
Business Units (referred to as workstreams by
Shibumi), and a Program. In CoE Manager, these
are all called work items. They are places to review
and add information. Each of these work items are
made up of tabs and sections.
Work item basics

Roles and user management Users are assigned to specific roles, and the
role determines how the user interacts with CoE
Manager. In CoE Manager, all users have inherited
permissions, which means that the permissions
extend below where they have access.
Roles and user management

Workspace CoE Manager workspace is divided into Navigation
Sidebar, Header, and Work Area.
Workspace overview

Personas and available actions CoE Manager personas represent the people
within your organization who participate in your
automation program. The titles given to these
personas might not match the job titles used within
your organization. Use the goal descriptions to
help you map your organization titles to the CoE
Manager personas. Once you have mapped your
positions to the CoE Manager personas, the topics
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to cover column (in Persona overview link below)
highlights the solution activities most applicable
to the persona. Persona-specific support site
articles are available through the persona column
hyperlinks.
Persona overview

Review automation program status Review up-to-date program data in a single location
to drive decision making.
Reporting

CoE Manager FAQ
For details and questions on the CoE Manager powered by Shibumi platform, review this FAQ.

Panoramica

What is CoE Manager? CoE Manager (powered by Shibumi) is a cloud-
based solution to manage the automation pipeline,
delivery, and benefits of the automation program.

Why do I need CoE Manager? CoE Manager helps you take control of your end-to-
end automation lifecycle while accelerating pipeline
generation. It helps CoEs to scale automation
programs more quickly and efficiently driving core
Automation Anywhere deployments and maximize
the value (ROI) from your automation investment.
CoE Manager elevates the value of the pipeline of
automation opportunities to build the business case
for additional investment.

I already have an existing app for managing
my automation pipeline. Do I still need CoE
Manager?

CoE Manager is a purpose-built automation CoE
management solution that provides advanced
capabilities to drive automation success and
comes with a native integration with Automation
Anywhere. It eliminates the manual overhead
required in a homegrown tool and allows CoEs
to focus on accelerating the automation pipeline
instead.

Is CoE Manager a SaaS solution? Yes, CoE Manager is hosted in Shibumi's cloud
infrastructure. Shibumi uses AWS as their cloud
provider. Currently, CoE Manager/Shibumi RPA
accelerator is hosted in the AWS zones in North
America, Germany, and Australia.

Which compliance standards does CoE
Manager support?

Automation Anywhere and Shibumi are committed
to maintaining compliance with key global
information security and regulatory standards,
including:
• Service Organization Control (SOC) 2, Type 2

certification
• CSA Cloud Controls Matrix standards compliance
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• EU Model clauses supported

What data retention policies, if any, are in
place?

Shibumi retains customer information for as long as
the account is active, or for as long as it is needed
to provide a customer or sponsoring organization
with specific requested services.

Do I need Automation Anywhere to use CoE
Manager?

No. CoE Manager can work independent of
Automation Anywhere. However, Actual ROI
information cannot be recorded in COE Manager
unless it is linked with an Automation Anywhere
Control Room.

What is the Opportunity Lifecycle enforced by
CoE Manager? Can it be modified?

All opportunities in CoE Manager follow a tollgate
process comprised of 4 stages given below:
• Stage 1: Idea
• Stage 2: Pipeline
• Stage 3: In corso
• Stage 4: Distribuito

These four stages are not configurable by an
administrator or end user. However, they can be
customized by Automation Anywhere for your
implementation of CoE Manager if desired. Contact
your Automation Anywhere representative to
explore this.

Can I use CoE Manager to manage my
automation pipeline outside of Automation
Anywhere?

Sì.

Does CoE Manager support single sign-on? Yes, the CoE Manager supports full SAML or SAMLv2
integration into any IDP or SSO solution such as
Okta.

Per iniziare

How do I activate CoE Manager? Contact your Automation Anywhere representative
if your organization has not yet purchased CoE
Manager. Each SKU will represent a unit of one CoE
Manager instance for an unlimited number of users
per year.

How do I access CoE Manager? Depending on the region from where CoE Manager
was purchased, you can access CoE Manager
through one of below links.
• North America
• Europe
• APJ

Nota:  Your account should already be setup in
CoE Manager before you logging in. For the account
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setup process, refer to Getting started with CoE
Manager alla pagina 2929.

Is there an integration between CoE Manager
and Automation 360?

Yes, you can link up to three Automation 360
Cloud Control Room to a CoE Manager enterprise
instance. This allows CoE Manager to collect bot
activity data to monitor automation executions and
calculate achieved savings. For an On-Premises
environment, a bot will be provided to push data
from an On-Premises Control Room to the COE
Manager cloud.

Which version of Automation Anywhere is
CoE Manager compatible with?

CoE Manager integrates with Automation 360 Cloud
Control Room out of the box and integrates with
On-Premises environments through a digital worker.
For further details, refer to CoE Manager alla pagina
2926.

Does CoE Manager require any third-party
software applications?

No.

What are the hardware requirements for CoE
Manager?

CoE Manager is a cloud-based solution accessible
via a browser and does not need any hardware
setup.

Which browsers does the CoE Manager
support?

Google Chrome, Mozilla Firefox, Microsoft Edge, and
Safari.

Can CoE Manager integrate with third-party
reporting tools?

Sì. Contact your Automation Anywhere
representative to explore this.

Can CoE Manager integrate with third-party
process/task mining tools?

Sì. Contact your Automation Anywhere
representative to explore this.

Does CoE Manager support APIs? Sì. CoE Manager/Shibumi exposes create, read,
update, and delete capabilities through its GraphQL
API.

Can I customize dashboards? Sì. This feature will be enabled in a future product
release.

Can I export the dashboard and reports? Sì. You can export to Excel or CSV wherever
applicable. Export to PDF will be enabled in a future
release.

Can I add new business units to manage my
automation opportunities?

Sì. You can create as many business units as you
need. Ability to add sub-business units will be
provided in a future release.

How do I assign opportunity to a user? You can assign the opportunity to a user as given
below:
1. Open the opportunity.
2. Click the Avatar icon on the top right.
3. Enter the email address of the user you want to

add.
4. Select the role and click Add.
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I am unable to login into CoE Manager. What
do I do?

Contact your CoE Manager administrator to start a
password reset.

My organization already uses Shibumi. Can I
use CoE Manager with Shibumi license?

No. A new license needs to be purchased from
Automation Anywhere to use the CoE manager.

Can I do a bulk upload of automation
opportunities?

Sì.

Where do I report a problem with CoE
Manager?

For reporting any unexpected or deficient
functionality, submit a support ticket to Automation
Anywhere.

Can the email branding be changed to
customer's requirements?

This feature is not currently available.

Can I rename, copy, move, or delete an
opportunity?

Yes, you can access these options from the three
vertical dots icon on the top right.

Bot Store
You can access Bot Store from the Control Room. From Bot Store, you can download bots or packages to
your Control Room repository.
There are two ways for you to get bots and packages from Bot Store into your Control Room:
• You can load items directly from Bot Store to your Control Room, without needing to download the

items locally. Per informazioni, consulta Directly import bots and packages from Bot Store to Control Room
alla pagina 2946.

• You can download items from Bot Store locally, then import them to your Control Room, even if your
Control Room is not connected to the internet. Per informazioni, consulta Download locally and import
bots and packages from Bot Store to Control Room alla pagina 2947.

Resources:  Per ulteriori informazioni, consulta Automation Anywhere Bot Store Learning Trail (A-People login
required).

Concetti correlati
Bot permissions for a role alla pagina 2706
Assign bot permissions when creating a role with the View my bots feature permission.

Access Bot Store from the Control Room
As a Bot Store registered user, you can log in to Bot Store from the Control Room.
You must have valid Bot Store credentials to access Bot Store from the Control Room. If you do not have
valid Bot Store credentials, you must register with Bot Store.
1. Accedi a Control Room.
2. Click the Bot Store tab.

Bot Store opens in a separate window (https://botstore.automationanywhere.com).
3. Log in using your Bot Store credentials.

In the Control Room, you can see My downloads under the Bot Store tab.
Watch the following video on how to find bots on Bot Store.
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Concetti correlati
Bot Store alla pagina 2944
You can access Bot Store from the Control Room. From Bot Store, you can download bots or packages to
your Control Room repository.
Attività correlate
Submit bots or packages to Bot Store alla pagina 2945
You can submit bots or packages from the Control Room to Bot Store. If your bot includes dependencies,
submit all dependencies. Submit a demo bot that demonstrates the use of the package.
Directly import bots and packages from Bot Store to Control Room alla pagina 2946
You can load items directly from Bot Store to your Control Room without the need to download the items
locally.

Submit bots or packages to Bot Store
You can submit bots or packages from the Control Room to Bot Store. If your bot includes dependencies,
submit all dependencies. Submit a demo bot that demonstrates the use of the package.
You must have a system-created AAE_Bot Store Publisher role in order to submit bots or packages to
Bot Store. Consulta System roles alla pagina 2709.
1. Download the A2019 Bot Store Bot template from GitHub: A2019 Bot Store Bot Template.
2. Accedi a Control Room.
3. Log in to Bot Store using the Bot Store credentials.
4. Nel pannello di sinistra, fai clic su Automazione.

Viene visualizzato un elenco dei moduli e dei  disponibili.
5. Click Public workspace and select the Bot Store folder.
6. In the Automation page, move your mouse over the Action toolbar and click Submit to Bot Store.

a) In the Submit to Bot Store page, review the dependencies that will be bundled with your bot
(including a parent bot) and make changes as required. In addition, ensure that the bot and all
dependent bots and files are in the same folder to submit to Bot Store.

b) Click Next to review the Bundled packages to ensure all packages are included with your
submission.

c) If the bot you want to submit and the bundled package look complete, click Submit.
When choosing a name for your bot or package, ensure it is unique and descriptive so it is easily
searchable on Bot Store.
Alternatively, click Back to go back.
When you submit your files, the system displays the following message: <bot/package name>
submission is in progress. Go to Bot Store > My Submissions to complete
your submission form. You will receive a confirmation email when the
submission is completed.

d) Click Take me to Bot Store to complete your submission form in Bot Store.

When you resubmit files to Bot Store, it overwrites the previously submitted files, which are in a
Draft status.
• It can takes three to five business days for review and approval of your bot or package.
• For any questions on bot and package submissions, contact Contact Bot Store Support or select the

Have questions about submitting a bot option on Bot Store pages.
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Concetti correlati
Bot Store alla pagina 2944
You can access Bot Store from the Control Room. From Bot Store, you can download bots or packages to
your Control Room repository.
Attività correlate
Access Bot Store from the Control Room alla pagina 2944
As a Bot Store registered user, you can log in to Bot Store from the Control Room.
Directly import bots and packages from Bot Store to Control Room alla pagina 2946
You can load items directly from Bot Store to your Control Room without the need to download the items
locally.

Directly import bots and packages from Bot Store to Control Room
You can load items directly from Bot Store to your Control Room without the need to download the items
locally.
You must have a system-created AAE_Bot Developer role in order to download bots or packages to your
Control Room repository. Consulta System roles alla pagina 2709.
1. Navigate to Bot Store site.
2. Log in with your A-People credentials to download from Bot Store.
3. Select a bot or package.

Once you have selected your bot, you are redirected to a detailed bot page.
4. Click the Get Bot button.

A confirmation window prompts you to confirm the request.
5. Click Ok, Get Bot to confirm the request.

You can choose from the Add to Control Room or Download as a zip file options.
• The Add to Control Room option requires you to specify your Control Room URL.
• The Download as a zip file option requires you to save the bot locally on your device and

confirm the location path for your download to begin.

6. Select the Add to Control Room option to load the bot directly to your Control Room.
7. Enter your Control Room URL.
8. Accedi a Control Room.
9. Navigate to the Automation page.
10. Open your Bot Store tab.
11. Click Add to RPA Workspace in the Action toolbar.

The following message appears: If you have any files already installed in private
workspace, they will be overwritten.

12. Select Yes, continue to overwrite an existing file and continue with the installation, or select No,
cancel to cancel your download.
The installation status of the selected file changes to Installed.

13. Verify the downloaded bots in your Bot Store folder of the private workspace.
The custom packages downloaded from Bot Store are available in the Packages repository. You can
navigate Bot Editor > Action Palette.

14. Verify that the downloaded packages have been enabled in the Packages repository. If the packages
are not enabled, then go to individual packages and enable them.
Watch the following video on how to download a Bot Store bot to your Control Room.
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Concetti correlati
Bot Store alla pagina 2944
You can access Bot Store from the Control Room. From Bot Store, you can download bots or packages to
your Control Room repository.
Attività correlate
Access Bot Store from the Control Room alla pagina 2944
As a Bot Store registered user, you can log in to Bot Store from the Control Room.
Submit bots or packages to Bot Store alla pagina 2945
You can submit bots or packages from the Control Room to Bot Store. If your bot includes dependencies,
submit all dependencies. Submit a demo bot that demonstrates the use of the package.

Download locally and import bots and packages from Bot Store to
Control Room
You can download items from Bot Store locally then import them to your Control Room, even if your
Control Room is not connected to the internet.
You must have a system-created AAE_Bot Developer role in order to download bots or packages to your
Control Room repository. Consulta System roles alla pagina 2709.
1. Navigate to Bot Store site.
2. Log in with your A-People credentials to download from Bot Store.
3. Select a bot or package.

Once you have selected your bot, you are redirected to a detailed bot page.
4. Click the Get Bot button.

A confirmation window prompts you to confirm the request.
5. Click Ok, Get Bot to confirm the request.

You can choose from the Add to Control Room or Download as a zip file options.
• The Add to Control Room option requires you to specify your Control Room URL.
• The Download as a zip file option requires you to save the bot locally on your device and

confirm the location path for your download to begin.

6. Select the Download as a zip file option
You can save the bot locally on your device and when you confirmed the location path, your download
begins.

7. Accedi a Control Room.
8. Navigate to the Automation page.
9. Fai clic su Importa bot.
10. Fai clic su Sfoglia.
11. Select your downloaded zip file at the location path you saved.
12. Specify the option to have your bot in the Public or Private tab.
13. Click Import to import the downloaded bot.
14. Navigate to the Public or Private tab that you specified.
15. Open your Bot Store folder.
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16. Access the bot.
You can now use the bot from Bot Store to start your automation experience.
To use a Bot Store package, open the bot you want to edit and access package from the Actions
panel.

Nota:  For users who want proxy access to Bot Store, you can reference this knowledge base article
for a workaround.

Getting started with Private Bot Store
Use Private Bot Store to view and submit bots and bot use cases within your company. Use admin tools to
review and publish bots and manage users.
The following is a high-level overview of how to get started with Private Bot Store:
1. The Private Bot Store support team creates admin users for your company.
2. Optionally, the support team helps you set up SAML-based SSO or Active Directory Federation Services

(ADFS) integration.
3. Admin users grant other users Private Bot Store access and permissions. (It is automated if you use

SAML-based SSO or ADFS).
4. Users create bot listings and submit them for approval.
5. Admin users can approve or reject the submitted bots.

• If approved, the bot listing is published and is available on Private Bot Store for other users within
the organization to view.

• If rejected, the bot author receives feedback on what has to be updated. The bot author updates
the bot and resubmits it.

6. Other employees within the company access the published bot listings and use them in their
automation tasks.

Concetti correlati
Private Bot Store alla pagina 61
Private Bot Store is a secure internal bot marketplace for a company to post and share details and
documentation for all internally developed bots. Employees can easily discover internal bots and
commands to reuse in addition to all of the bots from the Automation Anywhere Bot Store vendors.

Set up A-People user access to Private Bot Store
A-People user access and management is included out-of-the-box with Private Bot Store. Within Private Bot
Store, your company admin can manage users. Other users with granted permissions can access Private
Bot Store with the same credentials they use for public Bot Store and other Automation Anywhere sites.
• Set up A-People user access

After your first admin users get access to Private Bot Store, they can add additional users. Any Private
Bot Store user with admin access can manage users from the Private Bot Store - User Access
Settings page.
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• Add new users individually or in bulk
a) Navigate to User Access Settings.
b) Click Add Users.
c) Enter the email addresses for the users you want to add.

Invited users will receive an invitation email with instructions to set up their account.

• Change user permission level
Only admin users can modify permission levels by selecting the correct level in the Access panel.

• Delete users
Select Delete in the Actions panel.

Attività correlate
Submit and approve bots using Private Bot Store alla pagina 2949
Use Private Bot Store to submit, review, and approve detailed bot listings for all of the bots your team has
built.

Set up SAML user access to Private Bot Store
Use SAML-based single sign-on (SSO) or Active Directory access to ensure that your Private Bot Store user
access is updated automatically when users join or leave your company. Users can log in to Private Bot
Store using the same credentials they use for other applications.
• Set up SSO or Active Directory Federation Services (ADFS) user access

The Private Bot Store support team will help you set up SSO or Active Directory user access.
• Provide details about Private Bot Store in your identity provider (IdP) settings.
• Provide the Private Bot Store support team some information about your system.

The Private Bot Store support team will verify the information and complete the integration.
After the integration is completed, your Private Bot Store user access will be managed automatically
by your SSO or ADFS user access.

• Change user permission level
Admin users can change a user's permission level by navigating to the Private Bot Store Settings page
and updating user permissions.
Admins can only modify a user permission level if a user is an active Private Bot Store user.

Attività correlate
Submit and approve bots using Private Bot Store alla pagina 2949
Use Private Bot Store to submit, review, and approve detailed bot listings for all of the bots your team has
built.

Submit and approve bots using Private Bot Store
Use Private Bot Store to submit, review, and approve detailed bot listings for all of the bots your team has
built.
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• Submit internal bots:
To submit a new bot:
a) From Private Bot Store, click My Submissions.
b) Click Add New Bot.
c) Enter all the required fields, such as bot description, benefits, and requirements.
d) Review the documentation examples for each field and follow the suggested guidelines.
e) Click Submit or click Save to save the bot before submitting it.

After you submit your bot, your Private Bot Store admin team receives an email to review the bot.
Your bot will be published or it might be send back for an update and resubmission.

• Review internal bot submissions
Private Bot Store admin users approve or reject bot submissions before they can be published.
a) As an admin user, navigate to Private Bot Store and click All Submissions.
b) Click Review Bot to review each submitted bot.
c) Approve or reject the submitted bot:

• Approve and publish a bot: On the Review Bot page, click Approve to publish the bot.
• Reject the bot and request updates: On the Review Bot page, click Reject to reject the bot

and send feedback to the bot submitter with instructions for updates.

Submit and manage bot ideas using Private Bot Store
Use Private Bot Store to submit, manage, and prioritize bot ideas for your development requirements.
• Submit bot ideas

a) From Private Bot Store, click Suggest Bot Idea.
b) Fill in all the fields about your bot idea, with as much detail as possible.
c) Fai clic su Invia.

After you submit the bot idea, your admin team will review and prioritize it. The admin team might
contact you for more information about your bot idea.

• Manage bot ideas
Private Bot Store admin users can manage and prioritize bot ideas.
a) As an admin user, navigate to Private Bot Store and click Manage Bot Ideas.
b) Click Review to review each submitted bot idea.
c) Edit any of the fields as required.
d) Select a Bot Priority level for the bot idea.
e) Fai clic su Salva.
f) Click the Mail icon to contact the bot idea submitter to request additional details.

Watch the following video on how to submit a bot idea to Bot Store.
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Custom filter management in Private Bot Store
Create your own filters and tags to organize your automations in Private Bot Store using the custom filter
management page.
Custom filter management enables you to perform the following activities:
• Rename any of the default filters such as Applications and Departments, and tags (specific

categories) such as Excel and Finance.
• Add up to six of your own custom filters.
• Add your own custom tags, with up to three nested layers of tags, for example, 2021 > Q1 > January.
• Select which filters you want to appear first in your Private Bot Store navigation.
• Select up to five top tags to appear first under their filter.

The custom filters are displayed throughout Private Bot Store, including:
• In the top navigation, filters on the left, and search results.
• On the listing submission form, where bot builders can select custom tags for their bots.
• On bot detail pages, where users can see how each bots is categorized.

Edit filters

1. You must have an admin user permission to access the Manage Filters page in Private Bot Store.
2. Navigate to Private Bot Store > Manage Filters > Admin Tools > Manage Filters.
3. Edit the default filters to match your company terminology.

Whenever possible, use default filter names, such as Departments, rather than creating your own
filters. As a result, all the existing bots are already tagged and you do not have to tag them again.

4. Under Actions, click the Rename Filter action (pencil icon) to rename the filter.
5. Click Add Filter to add a new filter. Enter the name for the new filter.

You can add up to six custom filters.
6. Select a filter and click Reorder entry on the left and place the filter into your desired order.

The filter order is reflected in the Private Bot Store navigation and the filter panel.
7. Click the delete (X) action in the right column to delete any custom filter.

You cannot delete default filters.

Edit tags

1. Navigate Admin Tools > Manage Filters > Actions select a filter and click the tree icon Add and
Edit Tags action.

2. Select a tag and click the tree icon to Add Child Tag within a tag. Enter a new child tag name.
You can add up to three layers of nested tags.

3. Click the Rename Tag action to rename any tag.
For the default tags, the original Tag Name continues to appear in the Default Name column for
your reference.
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4. Select up to five Top Tag in the left column to display those tags at the top of the list within each
filter.
Use this for your company most-used applications or other important bot categories. Other than the
selected Top Tag, tags are displayed in alphabetical order.

5. Click the delete (X) action to delete any custom tag.
You cannot delete the default tags.
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Ottimizza
Bot Insight is an analytics platform that provides real-time, interactive, and smart insights about business
processes and operational intelligence. Bot Insight is available with out-of-the-box dashboards that you
can start using instantly. These dashboards provide analyzes to measure the performance of your digital
workforce and predict and solve preventable business problems.

Business analytics through Bot Insight
Automation Anywhere Bot Insight processes real-time and interactive insights about business processes,
and provides operational intelligence. Access the bots, and manage and instrument them to gather
business analytics and insights, and publish dashboards.
1. Create and edit bots

The cloud-based bot editor provides tools, packages, and actions to create bots to automate
processes.

2. Instrument the bot for analytics

Business analytics provides information about the transactional analytics for the data that is logged
by the variables that are tagged in a task. The information provided can be about the total sales in a
month, invoicing and payment trends, insight about new customers, and quote-to-order ratio.

3. Access Bot Insight

Access Bot Insight to perform the business analytics.
4. Customize dashboards and widgets

Dashboards represent the RPA infrastructure in the form of meaningful visuals and charts, so that
you can analyze, interpret, and take action on the updates that are important to you. The dashboards
display dynamically updated information of active users, registered clients, failed tasks, apps, bots, bot
schedules, workflows, queues, and the overall status of devices.

5. Publish a business analytics dashboard

Publish a dashboard to display the production data generated by the task. The analytics consumers
who primarily analyze and interpret data can access the published dashboard.

To learn more, search for the Managing RPA Reports Using Automation 360 course in Automation Anywhere
University: RPA Training and Certification (A-People login required).
Concetti correlati
Dashboard di Bot Insight alla pagina 2956
I dashboard di Bot Insight forniscono dati grafici dedicati per aiutarti a visualizzare le informazioni sui bot.
Attività correlate
Run your first bot alla pagina 1062
Run a bot from the same device that you used to create the bot.
Riferimenti correlati
Analyze package alla pagina 1392
Use the actions in the Analyze package to specify the actions and variables to use in the Bot Insight
dashboard and widgets. The Analyze package enables you to perform transactional analytics for the data
that is logged by the variables when the bot runs.
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Accessing Bot Insight
This section provides information about how to access Bot Insight.
To use Bot Insight business dashboard, the Control Room must have the Bot Insight license applied, and
you must be logged in as a user with one of the following roles:
1. AAE_Bot Insight Expert

2. AAE_Bot Insight Consumer

3. AAE_Bot Insight Admin

To use Bot Insight external APIs, you must be logged in as a user with AAE_Bot Insight Admin role.

Access Bot Insight from the Control Room
Access Bot Insight to interactively analyze bot data and enhance bot widgets.
Access Bot Insight from the Control Room in one of the following ways:
• From the Control Room, select Dashboard.

a) Locate the Insights tab.
b) In the Insights tab, click Explore Bot Insight.

The Bot Insight window appears.

• Nel pannello di sinistra, fai clic su Automazione. Viene visualizzato un elenco dei moduli e dei bots
disponibili.
a) In the Automation page, click PUBLIC to view the public bots that can be viewed, run, and

checked out by other people, based on the permissions set by the administrator.
b) Click PRIVATE to view your bots and files.

Nota:  Private bots and files cannot be viewed by other users. If a bot or file is checked out from
the PUBLIC tab, it can be viewed and run by other users. However, the bots and files cannot be
edited by other users.

c) Select your bot from the Files and Folders menu.
Alternatively, enter the search parameters in the Search Name field and search for your bot.

d) Open the bot and click Analyze.
The Bot Insight window appears.

Ruoli per accedere a Bot Insight
La Control Room limita l'accesso a Bot Insight agli utenti con determinati ruoli.
L'accesso al dashboard dipende dai ruoli utente assegnati a un utente e dall'autorizzazione di accesso
concessa a tali ruoli utente. Vedi Controllo degli accessi basato su ruolo.
System-generated access is provided to all user types for Bot Insight. Admins can customize the Bot
Insight experience by assigning a user-generated role to users. Ogni ruolo include un set di autorizzazioni,
progettate per specializzare le funzionalità Bot Insight e rendere l'analisi più semplice o più completa.
Admins should evaluate user tasks and functions to assign the role most appropriate to fulfill user
responsibilities, based on the following details.
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Nota:  Various types of dashboards can be accessed for quick insights. Common types are listed below.
For more details on dashboards, see Dashboard di Bot Insight alla pagina 2956
• The system-generated dashboard is also known as a Default type.
• The user-generated dashboard is also known as a Custom type.
• The Published dashboard is also known as the Production type.
• When a published dashboard is saved by a user, the dashboard copy is known as a custom

production type.

Apart from Bot Creators, users with the following roles have access to business analytics dashboards:

Admin Bot Insight Utilizza questo ruolo per eseguire le seguenti
operazioni in Bot Insight:
• Access Bot Insight API
• Analyze the Data Profile of the task data for

which the dashboard report is generated.
• Analizza e salva i dashboard generati dal

sistema.
• Analizza, salva, pubblica ed elimina i dashboard

generati dall'utente e i dashboard pubblici.
• Aggiungi segnalibri, confronta e condividi i

dashboard.

Esperto Bot Insight Utilizza questo ruolo per eseguire le seguenti
operazioni in Bot Insight:
• Analizza i dati nei dashboard distribuiti

nell'ambiente di produzione.
• Salva i dashboard generati dal sistema.
• Analizza, salva, pubblica ed elimina i dashboard

generati dall'utente e i dashboard pubblici.
• Aggiungi segnalibri, confronta e condividi i

dashboard.

Consumatore Bot Insight Utilizza questo ruolo per eseguire le seguenti
operazioni in Bot Insight:
• Analizza i dati nei dashboard distribuiti

nell'ambiente di produzione.
• Aggiungi segnalibri, confronta e condividi i

dashboard pubblici.

Role-based access control in Bot Insight
Role-based access control (RBAC) enables a Control Room administrator to restrict access to the various
components of Bot Insight.
The Control Room administrator can grant access to various user roles based on your requirements. When
adding a user, you assign appropriate roles to that user. A user will have access to the components and
folders based on the roles assigned to them.
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Requirements

Before you publish the dashboard, ensure that the following requirements are met:
• The bot resides in the Public workspace for which you want to publish the dashboard.
• You have the View my bots and Check in permissions to the folder that contains the corresponding

tasks. You need these permissions to move your bots from Private workspace to Public workspace.

RBAC for business analytics

Dashboards for business analytics are available for the tasks that are enabled for analytics. The Control
Room administrator and users who have access to a task can view the dashboards for those tasks. You can
access the dashboard for a task from the Insight tab in the DASHBOARD section of the Control Room
and from the ANALYZE tab in the Workbench.
To view the Bot Insight dashboards, you must be granted access to the folder containing the
corresponding tasks.
For example, you have created various tasks related to sales and accounting and stored them in the Sales
and Accounts folder. If you want to grant access to the sales-related tasks to members of your sales
department, you need to provide them access to the Sales folder. The same applies to grant access to the
accounts-related tasks in the Accounts folder.
The following table illustrates the access the various members of the Sales and Accounts team will have:

Sales_Dep Accounts_Team

John Mark Dave Smith Micheal

Access to
the Sales
folder

Sì Sì Sì No No

Sales1 Sì Sì Sì No No

Sales2 Sì Sì Sì No No

Access
to the
Accounts
folder

No No No Sì Sì

Accounts1 No No No Sì Sì

Accounts2 No No No Sì Sì

Accounts3 No No No Sì Sì

Dashboard di Bot Insight
I dashboard di Bot Insight forniscono dati grafici dedicati per aiutarti a visualizzare le informazioni sui bot.
I dashboard mostrano oggetti visivi e grafici importanti affinché tu possa analizzarli e interpretarli, nonché
intervenire sugli aggiornamenti importanti per te. Puoi utilizzare informazioni aggiornate dinamicamente su
utenti attivi, attività non riuscite, app, bots, programmi di bot, flussi di lavoro, code e sullo stato generale
dei dispositivi per creare dashboard e widget personalizzati.
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Nota:  Devi utilizzare il package di analisi con versione 2.3.0-20210922-121532 e successive per generare
il dashboard durante l'esecuzione dell'analisi. Questa versione del package è disponibile da Automation 360
v.23.

Per applicare il package, procedi come descritto di seguito.
1. Dalla Control Room, seleziona Gestisci > Pacchetti > Analizza.

2. Cambia la versione del package di analisi in 2.3.0-20210922-121532 o successive.
3. Salva le modifiche.
4. Esegui il bot e verifica la modifica per la generazione del dashboard.

Nota:  Per applicare le modifiche nello spazio di lavoro pubblico, archivia il tuo bot prima di eseguire
l'analisi.

Quando crei ed esegui un bot, Bot Insight crea automaticamente un dashboard predefinito nella raccolta:
I miei dashboard. Se disponi di un bot padre e di un bot figlio, Bot Insight crea un dashboard separato per
ognuno.
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Nota:  The system does not automatically refresh (auto-refresh) the Bot Insight dashboards unless the
user loads a screen or clicks the Refresh button, thereby manually refreshing data on a page.

Quando distribuisci ed esegui un bot sul computer Bot Runner, Bot Insight aggrega tutte le informazioni
correlate a tale bot. Il dashboard pubblicato per tale bot mostra le informazioni aggregate del bot.

Nota:  Some data might not populate in a widget if bots were created in Automation 360 v.12 or earlier
versions. See the following article for troubleshooting: Bot Insight dashboard not populating data in specific
widgets (A-People login required).

I miei dashboard mostra i seguenti dashboard:
• Operations dashboard alla pagina 2959
• Business dashboard alla pagina 2962

Nota:
• Devi disporre del ruolo AAE_Bot Insight Admin o AAE_Bot Insight Consumer per visualizzare

il dashboard pubblicato.
• The data visible on the dashboards is in the UTC time zone.

Viewing Bot Insight dashboards
The Bot Insight dashboards provide customizable widgets for you to gain insights in specific scenarios. You
can view information about your bots on the Bot Insight dashboards from the Control Room.
When you tag variables for analytics in a task and then run the task, Bot Insight generates the analytics
dashboard. By default, the system-generated dashboard has the same name as that of the task. You can
customize this dashboard to your requirements.
Business analytics provide information on the transactional analytics for data that is logged by the
variable tagged in a task. The information provided can be about total sales in a month, invoice, payment
trends, new customer insights, or quote-to-order ratio. You can select your dashboard from the Select a
Dashboard drop-down menu to view the analytics.
Bot Insight provides the following dashboards:
• Configure

The system-generated dashboards are available in the Configure tab in the Bot Insight window.
• Analyze

The customized dashboards can be published and are available in the Analyze tab in the Bot Insight
window.

• Operation
The Operation dashboard provides information about bots that are created, deployed, or scheduled
to run across different Bot Runner machines. You can use the information to enhance productivity and
take measures based on real-time information for RPA deployments.

1. Log in to the Control Room with one of the following roles:
• AAE_Bot Insight Admin
• AAE_Bot Insight Expert
• AAE_Bot Insight Consumer
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2. Click Explore Bot Insight from the Insights tab.
The Bot Insight dashboard appears in a new window.

Viewing Insights
You can view information about business data in Bot Insight.
Click Insights from the Analyze tab to view information about interesting facts on business data.
The Insight dashboard provides information about business data that is logged through Bot Insight without
the need to analyze the dashboards. It provides a snapshot of data that you can use to enhance your bot
productivity. This feature highlights important facts that are inferred from within the business process data
logged by the bots.
A bot created to process orders displays the following information:
• Total processing cost
• Process time
• Monthly payment
• Total payment

The dashboard provides information about the difference between the calculated metric values for a
specific time interval:
• Yesterday
• Ultimi 7 giorni
• Ultimi 30 giorni

The Insight dashboard enables you to configure the variance thresholds for indicating metric-level health.
Perform the following steps to configure the variance thresholds:
1. Click Settings.
2. In the Variance Threshold window, move the slider to the left or the right to adjust the variance

threshold.
• Move the slider to the left for a Poor metric health level.

The poor metric level health is represented in red.
• Move the slider to the right for a Good metric health level.

The good metric level health is represented in green.

3. Enter the values in the Fair field to set the Fair metric health level.
4. Select the Switch poor and good check box to switch between the Poor and Good metric health

levels.
5. Fai clic su Salva.

Operations dashboard
The Bot Insight Operations dashboard provides information about bots that are deployed on different
Bot Runner machines and bot statistics based on performance. You can use this information to enhance
productivity and take measures based on real-time information for RPA deployments.
The Operations dashboard provides visual insight into various operational aspects of bots and displays
hyperlinks to the following dashboards:
• Bots Dashboard
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• Audit Dashboard
• Device dashboard

Nota:  Ensure that you have the AAE_Admin role to view all bots information in the operations
dashboards.

These dashboards appear as the Default dashboards and are automatically created by Bot Insight
based on the variables that are used in the bot. You can use the Save As function to save the Default
dashboard as a Custom dashboard. You can also add widgets from the Visualizations menu to your custom
dashboards.
Using widgets alla pagina 2975

Bots Dashboard

You can view information about the bots that are created, deployed, scheduled, and running across various
Bot Runner machines.
The dashboard displays the following bot information:
• Total Bot Runs: Displays the total number of times the checked-in bots executed from the Bot Runner

machines. (The number displays the total number of bots that have run successfully and failed to run).
• Total Completed (Success): Displays the number of bots that have ran successfully.
• Total In Progress: Displays the number of in-progress bots.
• Total Failed: Displays the number of bots that had failed to deploy or run.
• Weekly Bot Status: Displays the weekly status of bots that are scheduled to run.

Suggerimento:  You can hover over the widget to view the number of bots that have run successfully,
failed to deploy, and failed to run. It also displays the weekly bots statistics percentage.

• Failure Reasons: Displays reasoning information on bots that had failed.

Nota:  The Error Message field displays a snapshot of the original error message and extensive
details on why the bot failed. You can export the error messages and logs to a CSV file, which you can
later use to troubleshoot.

Additionally, the Bots dashboard displays the Bot duration (such as minimum, maximum, average, and
summation) of each bot. You can create your own dashboard, add any widget, and calculate the minimum,
maximum, average, and summation of bot run time.

Audit Dashboard

This dashboard displays various widgets that provide information about Control Room events. Users with
the View everyone's audit log actions permission have access to view the audit information
captured in the Control Room.
System roles alla pagina 2709.
The dashboard displays the following information:
• Event Distribution by Activity Type
• Event Distribution by User Name
• Event Distribution by Source
• Event Distribution by Control Room Source
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• Event Distribution by Workbench Source

You can perform the following actions in the Operations dashboard:
• Enter the name of the dashboard in the Search text box to access a dashboard.
• Click the Favorite tab to bookmark your dashboard.
• Double-click the Favorite menu to remove bookmarks.

You can view information in the following tabs:
• Total Views: Displays the number of users who viewed a particular dashboard.
• Last Refreshed: Displays the time and date of when a particular dashboard was last refreshed.

You can click the arrow next to the Operations dashboard tabs to organize the dashboards to your
requirements.
You can customize the widgets in the Operations dashboard. You can perform the following functions:
• Working with Bot Insight dashboards alla pagina 2969
• Comparing dashboards alla pagina 2969
• Sharing a dashboard alla pagina 2972
• Taking a screenshot of a dashboard alla pagina 2973
• Downloading a PDF file from a dashboard alla pagina 2972

Device Dashboard

The Device dashboard displays various widgets that provide information about resource utilization of the
machines on which bots are executed.
The dashboard provides key metrics to analyze the status and utilization of devices. It also displays the
activity history of the bots that are deployed on the machines.
The dashboard displays the following information:
• Online Devices: Displays the number of Bot Runner machines that are active or online at a point in

time.
• Offline Devices: Displays the number of Bot Runner machines that are inactive or offline at a point in

time. Devices can be online even though no bots are deployed on them.
• Bot Schedules on Devices: Displays the number of bots that are scheduled to run on all the Bot

Runner machines.
• Device Utilization%: Provides the overall time used by bots that are executed across all the Bot

Runner machines. You can view and analyze the utilization information by date using the following
criteria:
• Bot duration
• Unit: %
• Group 1: Start date time of a bot (interval: day)
• Group 2: device name

There is no limit on the number of devices that can be displayed on the dashboard.
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• Device Activity History: Provides information about the execution history of bots deployed on each
Bot Runner machine. The Device Activity History table provides the following information:
• Nome dispositivo
• Nome Bot
• Bot duration (milliseconds)
• Start date time of a bot
• End date time of a bot
• Stato

When the Group1 and Group 2 fields have date type variables and you select Bot Duration as a
metric, the Percentage (%) option appears as an additional option for Bot Duration Unit. Based on
the selected group interval, the percentage is calculated for the bot duration.
Esempio: When you select the parameters in the following fields as:
• Group By or Sub By: Data
• Interval: Anno
• Metric: Bot Duration
• Bot Duration Unit: Percentage (%)
• The percentage calculated for bot duration is:

(10000/1000ms * 60s * 60m * 24h * 365days) * 100 = %

Nota:  The percentage calculation of the bot duration is available in all the widgets, except datatable
and maps.

• Top Error Messages: Provides information about the error messages for any bot failure and the
frequency of occurrence.

Business dashboard
The Bot Insight Business dashboard provides information about the Bot Insight data and statistics based
on bot performance. You can use this information to enhance your productivity and take measures based
on real-time information for RPA deployments.
The Business dashboard provides visual insight into the various business aspects of the bots. From this
dashboard, you can access both the Default and Custom dashboards.
Bot Insight automatically creates the Default dashboard based on the variables that are used in the bot.
You can use the Save As function to save the Default dashboard as a Custom dashboard. You can also
add widgets from the Visualizations menu to your custom dashboards.
Using widgets alla pagina 2975
In the Custom dashboard, Bot Insight enables you to export data from a dashboard widget to CSV files.
Exporting data from a dashboard widget alla pagina 2980
You can perform the following actions in the Business dashboard:
• Enter the name of the dashboard in the Search text box to access a dashboard.
• Click the Favorite tab to bookmark your dashboard.
• Double-click the Favorite menu to remove bookmarks.

The dashboard displays the following bot information:
• Bot Name: Displays the name of bots that are associated with the business dashboards.
• Total Views: Displays the number of users who viewed a dashboard.
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• Last Refreshed: Displays the time and date on which a particular dashboard was last refreshed.
• Modified By: Displays the name of the user who had last modified the dashboard.

You can click the arrow next to the Business dashboard tabs to organize the dashboards to your
requirements.
In the Dashboard Name tab, select the dashboard that you want to access to view the dashboard. You
can also enter the name of the dashboard in the Search text box to access the dashboard directly.
Click Rank in the Distinct Count row to view the rank of each variable. You can view the string data type
values that are logged by a variable for the maximum or minimum number of times. This further enhances
your ability to verify that the data is logged correctly in the bot.
Viewing ranks of string datatype values alla pagina 2970
The Business dashboard widgets displays the following information:
• The total number of variables
• The comparison between number variables and transaction status
• The comparison between number variable distribution and transaction status
• A bar chart representing the distribution between the number variables and string variables
• A pie chart representing the relationship between variables in numbers and strings

The Profile dashboard displays bot variables and the transaction data. The Task Name table displays the
variable name, display name, data type, inclusion details, maximum, minimum, average, sum, distinct
count for the date, string, and number variables.
The Transaction Data table displays the variable name, display name, data type, inclusion details,
minimum, maximum, average, sum, and distinct count metrics for the following parameters:
• Machine Name
• Transaction Name
• Transaction Start Time
• Transaction End Time
• Total Transaction Duration (Start Time - End Time)
• Transaction Status (In Progress or Completed)
• User Name (User who runs the bot)

You can use the Preview Data option to view the total number of records maintained for each variable.
When you create and run a bot with multiple Transaction Blocks with Analyze, Open, or Close
commands, all the tagged business variables are displayed in the Transaction Names menu.
You can customize the widgets in the Business dashboard. You can perform the following functions:
• Working with Bot Insight dashboards alla pagina 2969
• Comparing dashboards alla pagina 2969
• Sharing a dashboard alla pagina 2972
• Taking a screenshot of a dashboard alla pagina 2973
• Downloading a PDF file from a dashboard alla pagina 2972

Document Workspace dashboard
The Document Workspace dashboards provide visualizations of learning instance performance and quality
metrics as well as validation operations metrics.
Users with access to Document Automation can view and customize the Document Workspace dashboard
without additional permissions.
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The Document Workspace dashboard contains eight widgets, which contain visualizations of learning
instance data. The widgets are customizable:
• You can reposition a widget by dragging and dropping it into a new location.
• You can apply filters, such as by specific learning instance or time frame. Adding a dashboard filter alla

pagina 2968
• You can click a data point in a widget to "drill down" or filter the metrics in that widget. See the

following video:

Document Workspace widgets

Widget Descrizione

Accuracy % by field A horizontal stacked bar chart that shows the
straight-through processing percentage for each
field in the learning instances

Extraction time per documents A horizontal stacked bar chart that shows the
average extraction time per learning instance in
milliseconds

Number of uploaded documents A line chart that tracks the total number of files
uploaded each day

Number of uploaded pages A line chart that tracks the total number of pages
uploaded each day

STP% by learning instance A horizontal bar chart that shows the straight-
through processing percentage for each learning
instance

STP% over time A line chart that tracks the straight-through
processing percentage for all the leaning
instances by day

Validator performance by weighted average
validation time

A horizontal bar chart that shows the weighted
average time each Validator user spent
performing manual validation per document.

Validator performance by # of documents
validated

A horizontal stacked bar chart that shows the
number of documents each Validator user
validated per day

Dashboard filters

You can use the following dashboard filters to customize the metrics included in the dashboard:
• Learning Instance Name

Nota:  By default, both public and private learning instances are included in the dashboard.

• Tipo di documento
• Page Count
• Data di creazione
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Nota:  When you set a filter, it is applied to the entire dashboard. To apply a filter to a specific widget,
open the Widgets menu and select which widgets to apply the filter:

Attività correlate
Sharing a dashboard alla pagina 2972
You can share the link to view a dashboard through email using the Share via email option.
Downloading a PDF file from a dashboard alla pagina 2972
You can download the data available in the dashboard as a PDF file.
Taking a screenshot of a dashboard alla pagina 2973
You can take a screenshot of the data available in the dashboard.

AARI dashboard
Use the AARI dashboard in Bot Insight to view various widgets that provide information about requests
created from published processes in Automation Anywhere Robotic Interface (AARI).

Panoramica

The dashboard provides statistics and shows information about created requests for each process, which
can vary from a simple summary to a complex cross-departmental view. You can use this real-time
information to make process-related operational decisions. For example, consider a scenario where a
manager can get a high-level activity overview of completed and pending tasks in the payroll process,
which can then help the manager take necessary actions about the process.
From the AARI dashboard, you can access both the Default and Custom dashboards. Bot Insight
automatically creates the Default dashboard from the variables used in the process. You can use save the
Default dashboard as a Custom dashboard if required. You can also add widgets from the visualizations
menu to your custom dashboards.
Based on RBAC, the following users have access to view the data on the dashboard:
• AAE_Robotic_Interface_Admin can view all data inside AARI on the web interface across all teams.
• AAE_Robotic_Interface_Manager can view all data inside AARI on the web interface for their own

teams.
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What you can view in AARI dashboard

The dashboard helps you to visualize and track the number of requests that are open, completed,
canceled, or failed.
The dashboard also provides the following capabilities:
• Heat map chart: Visualize data about the percentage of request created for each process for a day.

You can specify the dates by function (day) to get specific information using the following criteria:
• Group1: created date (interval: day)
• Group 2: process name
• Metric: request created in percentage (%) for each process

• Request activity history: This table provides the execution history of the processes deployed on
each Bot Runner machine. It includes information such as the following:
• Nome processo
• Nome utente
• Request details such as the status, ID, end time and start time, duration
• Total human and bot duration
• Total human and bot tasks

• Stacked bar chart: Analyze the average duration taken by each process for human and bot tasks. For
example, consider that there are two processes named API Test-Form 1 and API Test-Form 2 in the bot
task type. For each process, the chart shows the average time (in seconds) taken for its execution. You
can view and analyze this information using the following criteria:
• Group 1: task type (human and bot)
• Group 2: process name
• Metric: duration (average)

Editing a data profile
You can modify the data profile of both the Default and Custom Business dashboards without modifying
the bots.
You can edit the data profile and regenerate the dashboard based on the new data profile. You can edit
the display name of a variable, change its data type, and exclude it from the dashboard.
Bot Insight provides smart data profiling for information about countries, states, and zip or postal codes.
Bot Insight analyzes the information provided in the variables and automatically identifies the information
as:
• Country (country code or country name)
• State (state code or state name)
• Zip code (five-digit zip code)

You can edit the data profile to convert the above parameters from numeric format to string format
(country and state) based on your requirements. You can convert the zip code to either string or numeric
format, and use the information to create widgets (world and US map widgets) in the Bot Insight
dashboard.
1. Open the Bot Insight dashboard.
2. Click Profile.

The Profile window appears, displaying all the variables that you have tagged during the bot creation.
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3. Fai clic su EDIT.
4. Specify a new name for a variable in the Display Name field.
5. Select an option from the Datatype drop-down list to specify a new data type for a variable.

You can change the datatype of a numeric variable to string, string to country, state, and zip code.

Nota:  Changes to the Data Type parameter cannot be reverted.

6. Clear the Inclusion check box to exclude the variable from the dashboard. Select Inclusion to
include a variable from the dashboard and configure how the initial SMART dashboard is generated.
You can view the minimum, maximum, average, sum, and last value for the numeric values, but not
for the string and timestamp variable types.

7. Click Save and Generate Dashboard to save the changes and generate the dashboard with the
updated value.

Bot Insight dashboard filter
The Bot Insight dashboard filter enables you to apply filters across your dashboards to display the filtered
data. You can save and publish the custom dashboards with preset filters.
Filters in the Bot Insight dashboard enables you to choose different views of the data. You can apply and
save filters in a dashboard to preserve the filtered view. The filtered view displays the same view the next
time you view the dashboard.
Dashboard filters enables different combinations of data in a single dashboard. The filter eliminates the
need for separate dashboards for different users. A single-filtered dashboard allows you to serve data
requirements for a wide range of users.
You can access the dashboard filter from both the Operations and Business dashboards. You can click
each item in the filter list to view the parameters. You can search for a specific parameter in the Search
Automation Name field in the All tab. You can select parameters based on whether to include or exclude
them in the filter. The selected parameters appear in the Selected tab.
When you apply a specific filter, the visual indicator in the dashboard displays the name of the applied
active filter. You can delete a dashboard filter by clicking the delete icon. When you publish a custom
dashboard with the applied the dashboard-level filters, the published dashboard contains the same filters.
You can click Widgets in the widget window to apply dashboard widgets.
The Bot Insight dashboard provides the following filters:
• Attributes: This filter enables you to include or exclude specific parameters of a given attribute. This

can be the bot name, device name, or user name.
For example, you can use the parameters:
• Model Version to differentiate the payload and to determine if an upgrade is required in the

dashboard. You can also use it as a filter so that the dashboard works correctly even with different
job execution pay loads.

• Job type to identify the type of task such as TASK(Bot Run), WORKFLOW, WORKORDER,
WLM_TASK

• Automation Name to provide a name when running or scheduling the bot
• Object Name to identify the name of the entity for which the audit action is recorded. For example,

to identify the username when the user is edited or created or the bot name when the bot is edited
or created.

• Numeric: This filter enables you to select a specific duration for which you can get the numerical
statistics of the bot. For example, this can be the totalLines that is processed by the bot, or the
duration during which the bot was active.
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• Time: This filter enables you to select a single date, or a range of dates to analyze the variables that
are categorized under time and date. This can be the bot start time or end time.

Concetti correlati
Operations dashboard alla pagina 2959
The Bot Insight Operations dashboard provides information about bots that are deployed on different
Bot Runner machines and bot statistics based on performance. You can use this information to enhance
productivity and take measures based on real-time information for RPA deployments.

Adding a dashboard filter
To create a dashboard filter, select a field containg the information type you want to filter and define the
return of the data. The filtered view is preserved so that the same view is displayed the next time you view
the dashboard.
1. Open the dashboard to which you want to add a filter.
2. Select the parameter based on your requirements in the Attributes tab, .

The parameter window appears.
a) Enter the name of the variable in the Search field.

The variable appears in the All tab. Select the variable that you want to add in the filter. The
selected variable appears in the Selected tab.

b) Choose one of the following options:
• Click Include to include the variable in the dashboard filter.
• Click Exclude to exclude the variable in the dashboard filter.

c) Fai clic su Applica.

The Attributes filter is added to the dashboard.
3. Select the parameter in the Numeric tab.
4. Perform these steps in the selected parameter window:

a) Select the condition that you want to specify in the filter.
b) Enter the minimum and the maximum values.
c) Fai clic su Applica.

The Numeric filter is added to the dashboard.
5. Select the parameter based on your requirement in the Time tab.
6. Perform these steps in the selected parameter window:

a) Select a specific date, or a range of dates.
b) Fai clic su Applica.

The Time filter is added to the dashboard.

Riferimenti correlati
Customizing a dashboard alla pagina 2970
Log in to Bot Insight with the AAE_Bot Insight Expert role to customize the information displayed in
the system-generated dashboard to make it more relevant for an analytics consumer.
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Working with Bot Insight dashboards
You can save or delete a Bot Insight dashboard when required. You can also delete a user-created
dashboard.
When you delete a dashboard, it does not impact the data associated with that dashboard. You can
delete dashboards that are available in the Analyze and Configure tabs of the Bot Insight window.
The dashboards available in the Analyze tab are the published dashboards. Therefore, if you delete a
dashboard from the Analyze tab, it will no longer be available for other users.
• Save a dashboard:

a) Open the dashboard that you want to save.
b) From the Actions menu, select Save as.

The Save Dashboard window appears.
c) In the Dashboard Name field, enter the name for the dashboard.
d) In the Dashboard Description field, enter the description of the dashboard.
e) Fai clic su Salva.

Click Save As to save a default dashboard as a customized dashboard.

• Open the dashboard you want to delete.
a) Click Delete on the toolbar.
b) Click Okay.

Comparing dashboards
You can compare dashboards that belong to two separate processes, or the same process with different
filters. The dashboards selected for comparison appears as a side-by-side view to enable you to obtain
better insights.
• Compare dashboards:

a) Open the dashboard that you want to compare.
b) Navigate to Actions > Compare in the Bots Dashboard.

Your dashboard is now in compare mode. The dashboard you have opened appears in both the
Left View and Right View. You can apply widget filters to your dashboard at any time.

• Apply widgets to your dashboards:
a) Click the Filter option from your dashboards, represented by the three dots in the corner.

The Filter window now appears and shows the available widgets.

Nota:  The Filter option next to the Close option accesses the same Filter window. You can also
expand or minimize the Filter window.

b) Select the Left View or Right View.
c) Select the Attributes, Numeric, or Time widgets that you want to apply.
d) Opzionale: Click Clear All to reset all your widget selections.
e) Click Apply to confirm.

You can now compare your dashboard with widgets.
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Customizing a dashboard
Log in to Bot Insight with the AAE_Bot Insight Expert role to customize the information displayed in
the system-generated dashboard to make it more relevant for an analytics consumer.
To make changes in a Bot Insight dashboard, create a copy of the dashboard, and then update the copy.
After you create customized dashboards for a bot, you can make changes to the tagged variables. You
can delete and add variables based on your requirements. By default, the standard dashboard always
displays the latest data profile. We recommend you use the system-generated standard dashboard, and
then create customized dashboards from it. Data profile updates are highlighted with a red dot in the
following scenarios:
• When there are data profile updates.

• The variables that are newly added display the message NEW.
• The variables that are deleted display the message DELETED.

• When the customized dashboard data profile does not match that of the standard dashboard.

Attività correlate
Editing a data profile alla pagina 2966
You can modify the data profile of both the Default and Custom Business dashboards without modifying
the bots.

Viewing ranks of string datatype values
Among string datatype values, you can view the ranking based on the maximum and minimum number of
times each string datatype value has been used, as logged by a variable. With this information, you can
better verify whether the data logged in the bot is correct.
1. Open the dashboard for which you want to edit the data profile.
2. Click the Profile tab.
3. Click Rank within the Distinct Count column.

The Distinct Count column displays the number of unique values logged by a variable.

Nota:  The Rank option is only available for the variables that log values of string datatype. A
message appears displaying the top five values that are logged for the maximum number of times in
the variable.

4. Select Bottom from the list to display the five values that are logged the least number of times in the
variable.

5. Select an option from the list to display five or ten values in the message box.

Previewing data
You can view all the variable data associated with a task using the Preview Data option.
1. Open the dashboard for which you want to preview the data.
2. Click the Data Profile tab.
3. Click the Preview data option.

A new window appears displaying all the variable data associated with that task.
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Verifying data populated in a custom dashboard
After you create a custom dashboard that contains new widgets or customized widgets from the system-
generated dashboards, you can verify the data that is populated in the dashboard.
1. Open the task for which you want to verify the data in Bot Insight.
2. Click Run on the toolbar.
3. Click the ANALYZE tab.

The system-generated dashboard for the task appears.
4. Click the Analyze tab in the Bot Insight window and search for the customized dashboard for which

you want to verify the data.
5. Select the dashboard from the search results.

The dashboard appears.
6. Click the Data Profile tab and verify the data for the dashboard.

Publishing a business analytics dashboard
Bot Insight enables you to publish a business analytics dashboard that is generated for a task. You can
publish both the Custom and Default Business dashboards.
Before you publish a dashboard, ensure that the particular bot resides in the Public folder in the Control
Room.
1. Open the dashboard that you want to publish.
2. Customize the dashboard based on your requirements and verify the content and presentation

formats.
3. Click Publish on the toolbar.
4. Specify a name for the dashboard, and then click Okay.

The dashboard is now published and available to display the production data generated by the task.
The dashboard updates the data each time a task runs in the production environment from the Control
Room on a regular basis.
In the Control Room, ensure that you deploy the bot in the Bot Runner device so that the published
dashboards are populated with data.

Attività correlate
Importa bots alla pagina 2837
Puoi importare bots con le relative dipendenze da una Control Room all'altra. L'ambiente di origine può
essere Automation 360 Control Room, Enterprise 11, or Enterprise 10Istanza Control Room.

Salvare un dashboard pubblicato
È possibile pubblicare un dashboard di analisi aziendale Bot Insight generato per un'attività. È inoltre
possibile salvare una copia del dashboard pubblicato quando necessario.
Ensure you have the AAE_Bot Insight Admin or AAE_Bot Insight Expert roles assigned to you.
1. Apri la finestra Bot Insight.
2. Fai clic sulla scheda Azienda e cerca il dashboard per il quale si desidera salvare una copia del

dashboard di produzione personalizzata.
3. Select the dashboard from the search results.

Viene visualizzato il dashboard selezionato
4. Seleziona Salva con nome dal menu Azione per salvare il dashboard di Produzione predefinito

come dashboard di Produzione personalizzata.
5. Nella finestra Salva dashboard, specifica un nome per il dashboard e fai clic su OK.
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È inoltre possibile aggiungere widget dal menu Visualizzazioni ai dashboard personalizzati.
È possibile aggiungere, eliminare, modificare la visualizzazione, applicare filtri e così via per
personalizzare il dashboard.

Eliminare un dashboard pubblicato
È possibile pubblicare un dashboard di analisi aziendale Bot Insight generato per un'attività. È inoltre
possibile eliminare un dashboard pubblicato quando non è più necessario.
Ensure you have the AAE_Bot Insight Admin or AAE_Bot Insight Expert roles assigned to you.
Non è possibile eliminare un dashboard di Produzione predefinito se ad esso sono associati dei figli
(dashboard di produzione personalizzati). È necessario eliminare prima il dashboard di produzione
personalizzato, quindi eliminare il dashboard di Produzione predefinito. Tuttavia, è possibile eliminare un
dashboard di Produzione personalizzata.
1. Apri la finestra Bot Insight
2. Fai clic sulla scheda Azienda e cerca il dashboard che si desidera eliminare.
3. Fai clic su Elimina dal menu Azione.
4. Fai clic su OK per confermare l'eliminazione.

Reviewing data in a published dashboard
You can review the data available in a published dashboard.
1. Open the Bot Insight window.
2. Search for the dashboard for which you want to view the data.
3. Select the dashboard from the search results.

The selected dashboard appears.
4. Review the data available in the dashboard.

The dashboard reflects the data processed by the task in the production environment.
5. Export the entire dashboard in PDF or PNG format for offline consumption and review.

Sharing a dashboard
You can share the link to view a dashboard through email using the Share via email option.
1. Open the dashboard that you want to share.
2. Click Share via email on the toolbar.

The email client configured on your system appears. The email client contains a link to access the
dashboard.

3. Specify the email address of the recipients and send the email.

Downloading a PDF file from a dashboard
You can download the data available in the dashboard as a PDF file.
1. Open the Bot Insight window.
2. Search for the specific dashboard.
3. Select the dashboard from the search results.

The selected dashboard appears.
4. Review the data available in the dashboard.
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5. In the Actions menu, click Download PDF.
6. In the Download PDF window, navigate to the location on your local disk drive.
7. Fai clic su Salva.

Nota:  Due to a limitation within the third-party recharts library, you might observe labels overlapping
issue with data in downloaded PDF.

Taking a screenshot of a dashboard
You can take a screenshot of the data available in the dashboard.
1. Open the Bot Insight window.
2. Search for the dashboard for which you want to view the data.
3. Select the dashboard from the search results.

The selected dashboard appears.
4. Review the data available in the dashboard.
5. In the Actions menu, click Screenshot.
6. In the Download PDF window, navigate to your local disk drive location.
7. Fai clic su Salva.

Utilizzo di Bot Insight
Use Automation Anywhere Bot Insight to track bot data for analytics.
Automation Anywhere bots are built, run, and monitored in the Control Room. Bot Insight accesses real-
time business insights and digital workforce performance data to leverage content-level productivity data
from the bots that are deployed. Data is logged for business analytics who has Attended and Unattended
Bot Runner license .
Log in to Automation Anywhere Control Room as an AAE_Bot Insight Expert or AAE_Bot Insight
 Consumer to interactively analyze bot data and enhance bot widgets.
In the Control Room, select the Bot Insight tab, to do the following tasks:
• Interactively analyze the bot data in the dashboards.
• Refine and enhance widgets in the Bot Insight dashboards before they are published for wider

consumption and deployed to production.

Business analytics
Business analytics provide information about the transactional analytics for the data that is logged by the
variable tagged in a task. The information provided can be about the total sales in a month, invoicing and
payment trends, insight about new customers, or quote to order ratio.
When you tag variables for analytics in a task, and run the task, Bot Insight generates the analytics
dashboard . By default, the generated dashboard has the same name as that of the task. You can
customize the system generated dashboards based on your requirement.

Configuring a task for business analytics
To configure a business analytics automation task, enable analytics (using the Analyze: Open and
Analyze: Close actions) and tag the variables that are of interest for data analysis.
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To configure a task for business analytics in an existing bot:
1. Accedi a Control Room.

Nota:  Ensure that you have the Bot Creator license assigned to you.

2. In the Automation pane, select the folder that contains the task for which you want to enable
analytics.
The Actions palette appears in the left-hand side. Consulta Actions palette for bot creation alla pagina
1363.

3. Build a bot.
For more information about building and editing a bot, see Get started building bots alla pagina 2049.

4. Insert the Analyze: Open action at the beginning of the transaction.
5. Insert the Analyze: Close action at the end of the transaction.

The Analyze: Close menu lists all the variables in the transaction. Select the variables that are
tagged in the transaction to process business analytics.

Nota:  This feature enables you to deselect variables that might raise potential privacy concerns, such
as social security numbers or bank account details.

6. Fai clic su Applica.
Click Reset to reset the variable selection.

7. Fai clic su Salva.
8. Fai clic su Esegui.

The Bot Run Successfully message appears.

9. Click Analyze.
The Bot Insight window appears.

10. Select a bot from the Select a Dashboard drop-down list.
Click the arrow to view the list of bots.
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Using widgets
The Bot Insight dashboard provides a host of highly customizable widgets that you can use to gain insights
for specific scenarios.
When you select a particular bot, the default widgets automatically appear in the Dashboard window. You
can select the widgets and reposition them in the dashboard. To search for specific information, use the
Smart Filter function. You can enter the search parameters in the Smart Filter field.
You can also use multiple filters to search for data the widgets should display. Enter the filters, search
parameters, separated by a comma in the Smart Filter field. You can create, move, rename, and edit the
widget properties in a dashboard, based on your requirements.
The available options are:
• Chart filters
• Chart style
• Metric-based filters
• Comparison metrics

You can group information by dates and use the Date Interval to view when a particular bot was active.
The following Date type options are available:
• Hour
• Day
• Week
• Month
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Adding a dashboard widget
You can add custom widgets to the Bot Insight dashboard based on your requirements.
1. Open the dashboard.
2.

Click the  icon.
The Add Visualization window appears.

3. Select a widget that you want to add in the dashboard. Consulta Bot Insight visualizations alla pagina
2976.
The Selected Chart window appears.

4. Facoltativo: Click the Switch Widget button to change widgets.
5. Fai clic su Avanti.

The Construct Your Query window appears.
6. Enter the query information to construct your dashboard. For reference to create a widget query, see

Configuring a Line Bar Chart query alla pagina 2977.
7. Fai clic su Avanti.

The Ready to build window appears.
8. Fai clic su Conferma.

The widget appears in the dashboard.

Bot Insight visualizations
The Bot Insight dashboards provide customizable widgets that you can use to gain insights for specific
scenarios.
Bot Insight offers the following visualization widgets:
• Gauge Chart
• KPI
• Vertical Bar Chart
• Line Bar Chart
• Clustered Line Bar Chart
• Horizontal Bar Chart
• Vertical Stacked Bar Chart
• Horizontal Stacked Bar Chart
• Vertical Clustered Bar Chart
• Horizontal Clustered Bar Chart
• Heat Map
• Pie Chart
• Donut Chart
• Line Chart
• Scatter Chart
• Bubble Chart
• Datatable Chart
• World Map
• US Map
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The Pie Chart widget enables you to visualize data in a circular statistical graphics that is divided into
slices.

Nota:  Due to a limitation within the third-party recharts library, the data labels in a pie chart are
overlapping if it contains many slices. As a result, the labels in a pie chart are not clear and are shown only
when you hover over the slices.

The Heat Map widget enables you to visualize data as a heat map chart. You can specify the dates
by function (day, week, month, or year) to drill down to specific information. This map displays all the
possible available combinations of variable values in the X and Y axes. Blank heat map blocks appear if
there the value attached to the variable is 0. The color of the heat map block depends on the value of
the information displayed. A new window with all the relevant information appears when you hover your
mouse over a particular heat map block.
The Datatable Chart widget enables you to view and analyze information about all the logged data in
a tabular chart. You can select the attributes and metrics based on your requirement. All the available
attributes and metrics are selected by default.
The World Map widget provides information about the data variables and enables you to drill down to
specific information:
1. Country
2. State
3. Zip Code
4. Latitude
5. Longitude

The US Map widget provides the following information about the data variables and enables you to drill
down to specific information:
1. Country
2. State
3. City
4. Zip Code

The Line Bar Chart and the Clustered Line Bar Chart widgets enable you to view and analyze
information about your metrics and attributes. You can input two metrics and one attribute in Line Bar
Chart widget, while in the Clustered Line Bar Chart widget, a Sub group option enables you to add
one more attributes if necessary.
The widget displays a line bar graph aggregated by group values when only one attribute is selected or a
clustered line bar graph aggregated by subgroup values when two attributes are selected. It displays group
sectioning which forms multi-axes labels . You can use Date types as interval options, grouped by Day,
Week, Month, Quarter, and Year, with the Day set as default.
Configuring a Line Bar Chart query alla pagina 2977
Attività correlate
Adding a dashboard widget alla pagina 2976
You can add custom widgets to the Bot Insight dashboard based on your requirements.

Configuring a Line Bar Chart query
You can construct a custom query based on specific parameters to apply to your widget for line bar and
clustered line bar charts.
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After you are in the Construct Your Query window, follow these steps to select parameters to apply to
your widget:
• Construct your query settings.

The query settings vary from widget to widget, but the selection process remains the same.
a) Enter the title of your widget in the Chart Title field.
b) Select a metric option in the Metric or Select Metrics field.

For Line Bar Chart and Clustered Line Bar Chart, the Metric field is renamed to Y1 Axis and
Y2 Axis.

c) Select an aggregated value in the Aggregated By field.
For Line Bar Chart and Clustered Line Bar Chart, the Aggregated By field is renamed to Y1
Aggregated By and Y2 Aggregated By with the same options.

d) Select a value from the Group By or Group 1 field.
e) Select a secondary value from the Sub Group By or Group 2 field.

Nota:  The Sub Group By or Group 2 field is not available in the Line Bar Chart. For the
Metric, Group By and Sub Group By fields, the first value is shown as the default value.

f) Select a date value in the Date Interval field.

Nota:  This field appears when you select the Date Type variable in the Group By and Sub
Group By fields.

• Construct your advanced query settings.
You can enable more options to any widgets that support advanced settings.
a) Click Advanced Settings.

The settings display the default values. You can change the value of the fields if required.
b) Select a limit value in the Limit or Group Limit field.
c) Select a sort value in the Sort By or Group Sort By field.
d) Select a sort order value in the Sort Order or Group Sort Order field.
e) Select a secondary limit value in the Sub Group Limit or Group 2 Limit field.
f) Select a secondary sort value in the Sub Group Sort By or Group 2 Sort By field.
g) Select a secondary sort order value in the Sub Group Sort Order or Group 2 Sort Order field.

Nota:  The Sub Group Limit, Sub Group Sort By and Sub Group Sort Order fields are not
available in the Line Bar Chart.

Editing a dashboard widget
You can edit the dashboard widget properties based on your requirements.
You can resize and save the widgets in the Bot Insight dashboard based on your requirements. When you
resize a dashboard widget, other widgets in the dashboard are automatically adjusted to fill in the available
layout.
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Nota:  Bot Insight allows you to resize widgets in the standard and the customized dashboards. However,
it does not allow you to save the widgets after resizing in the standard dashboard.

1. Open the dashboard widget.
2. Click the Edit button.

The Edit window appears.
The Edit menu offers the following options:

Titolo grafico Renames the chart
Metrica Changes the units
Aggrega per Displays the run time (such as minimum,

maximum, average, and summation) of each bot
Raggruppa per Changes the parameters based on which the

widgets are grouped together
3. Click the bottom of a widget to change the attribute of the chart displayed within the widget.
4. Click Save As to save the widget.

Drilling down information in dashboard widget
You can drill down information from a dashboard widget based on your requirement. Select the options
available in the drop-down list to view specific information in the dashboard widgets.
To use the drill down function feature in the Bot Insight dashboard widget, do the following:
1. Open the dashboard and select the widget.
2. Right-click to view the Drill Down menu.

Drill Down menu sample for a mortgage analytics processing bot :
• Gender
• Mortage Type
• Customer ID
• Company Name
• E-mail
• Loan Due Date
• Loan Origin Date

Nota:  Bot Insight dynamically generates the Drill Down menu options based on the variables you
tag when creating the bot.

Renaming a dashboard widget
You can rename a dashboard widget based on your requirement. The default name of a dashboard widget
is based on the type of information that the widget displays.
To rename a widget in the Bot Insight dashboard, do the following:
1. Open the dashboard for the widget to edit.
2. Rollover and click the Edit button.

The Edit Chart window appears.
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3. In the Chart Title field, enter the name of the widget.
4. Fai clic su Avanti.

The Ready to build! Click Finish window appears.
5. Click Finish.

The Widget Updated message appears.

Exporting data from a dashboard widget
You can export data from the Bot Insight Custom Business dashboard widgets to CSV files based on the
requirement.
1. Open the dashboard.
2. Identify the widget.
3. Click the Actions icon.
4. Click Export.

The CSV file is automatically saved in your local drive as Chart name_summary_dd_mm_yyyy.

Data connector for Power BI
The data connector for Power BI enables you to establish a secure connection to Power BI, and generate
and visualize data analytics. You can connect to the Bot Insight APIs in Power BI and apply specific
parameters for each of the APIs.
The connector transforms the Bot Insight API responses to data visualizations in Power BI. The data
connector for Power BI enables you to perform the following functions in Power BI:
• Authenticate and connect to the Control Room.
• Connect to APIs.
• Generate API responses.
• Transform the API responses to create a data model.
• Create visuals, charts or graphs, to represent the data.
• Create reports.
• Share reports with other users on Power BI.

You can access the following APIs from Power BI:
• getaudittrialdata
• getbotrundata
• gettaskvariableprofile
• gettasklogdata

Nota:  Automation Anywhere Power BI connector is certified and available as part of the Microsoft Power
BI Desktop August release. The connector is available in the Other section of the Get Data dialog box in
Power BI.

To update your Power BI to the latest certified release version and use the connector plug-in, manually
deploy the data connector in Power BI. This enables you to retrieve information from the Bot Insight API
for data analytics.
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Problema:  When you attempt to refresh the data in a Microsoft Excel worksheet, an
authentication error can occur from multiple simultaneous attempts through open windows and
tabs. To avoid this error, perform the following steps:
1. Nell'applicazione desktop Power BI, vai a File > Opzioni e impostazioni > Opzioni.
2. From the Current File section, select Data Load.

Nota:  Non selezionare Carica dati dalla sezione Globale.

3. Disable the check box for Enable parallel loading of tables.

Informazioni correlate
Microsoft Power BI

Deploy Power BI connector
Deploy the data connector in Power BI to retrieve information from the Bot Insight API to enable data
analytics.
The connector can now be accessed directly from the Power BI desktop application. Ensure you meet the
following prerequisites.
• You should be using Power BI desktop version 2.92.943.0 or above.
• You know your Automation Anywhere Control Room version.
• You have your Control Room credentials.
• You have your Control Room URL.

The following steps describe how to deploy the connector.
1. From your Power BI desktop application, select Get data.
2. In the search field, type and select Automation Anywhere.
3. Fai clic su Connetti.
4. From the Login dialog box, enter your Control Room version and URL.
5. Enter your Control Room credentials.
6. Fai clic su Connetti.

Configure Power BI connector alla pagina 2981

Configure Power BI connector
Configure the data connector in Power BI to retrieve information from the Bot Insight API to enable data
analytics.
Ensure that you have the Bot Insight Admin, or AAE_Admin role assigned to you in the Control
Room.

:  A Bot Creator license is required to generate a default dashboard with tasklogdata for Power BI.

Nota:  The Power BI Connector is supported with Database Authenticated Control Room and Active
Directory authentication.

1. Accedi a Power BI.
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2. Click Get Data.
The list of all the Power BI certified connectors appears.
• For information about how to access non-certified custom connectors, see Connector extensibility in

Power BI.
• When you update the dataset of two or more datasets, you might observe the Authentication

500 Internal server error. For resolving this error, see Automation 360 | Authentication 500 Internal
server error while refreshing in power BI (A-People login required).

3. Select Automation Anywhere and click Connect.
4. In the Automation Anywhere - Login window, enter the following information:

a) In the Control Room Version drop-down menu, select the version of the Control Room.
b) In the Control Room Host field, enter the IP address or the host name of the Control Room

server.
c) In the Bot Insight Host field, enter the IP address or host name of the Bot Insight server.

5. Fai clic su OK.
6. In the Automation Anywhere Login window, enter your Bot Insight user name and password.

To provide the credentials for Active Directory authentication, you must enter the domain name
delimited by a double backslash (\\) along with the user name in the User name field. For example:
domain name\\user name.

7. Fai clic su Connetti.
The Bot Insight APIs are authenticated and the authorization tokens are generated. The Bot Insight
APIs are loaded dynamically from Swagger, along with the applicable request parameters.

8. Select the required Bot Insight API from the Navigator menu and enter the information in the
respective fields.

9. Click Load.
The API retrieves specific information from the server.
To learn how to retrieve information from Bot Insight APIs in Power BI, see Bot Insight API .

10. Click Transform Data to convert the structured JSON response to a visual data model.

Informazioni correlate
Transform, shape, and model data in Power BI
Create reports and dashboards in Power BI
Collaborate, share, and integrate across products with Power BI

Esempio: Retrieve information in Power BI using business
information API
The Power BI connector enables you to access the Bot Insight API from Power BI. This example task
shows you how to retrieve information from the Bot Insight API and build data visualizations in Power BI.
1. Open Power BI.
2. Open the Navigator window, and log in to the Control Room by entering the credentials.
3. In the Display Options menu, select fx Business Information.

The API window appears.
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4. In the botName field, enter the name of the bot, or the task for which you want to visualize the
analytical data.
To enter multiple bot names, separate each name with a comma.
For example, SalesAPAC,SalesEMEA,SalesUS.

5. In the pageNo field, enter the offset value for the rows or records that you want to retrieve.
• If page = 0, and limit =1000, then rows 0 -1000 will be retrieved.
• If page = 1, and limit =1000, then rows 1001 -2000 will be retrieved.

6. Opzionale: In the fromDate field, enter the date from when you want to retrieve the information.
Format: yyyy-mm-dd, or yyyy-mm-ddTh:m:s.msz (2020-02-20T12:45:23.000z)

Nota:  If you do not enter a date, the API will return all available data.

7. Opzionale: In the toDate field, enter the date till when you want to retrieve the information.
Format: yyyy-mm-dd, or yyyy-mm-ddTh:m:s.msz (2020-03-21T15:45:32.000z)

Nota:  If you do not enter a date, the API defaults to the current date.

8. In the limit field, enter the number of rows or records you want to retrieve.
9. Click Apply and then click Transform Data to convert the structured JSON response to a visual data

model.
10. Click Record and then click each list item until you drill down to the last element in business

information.
Power BI displays the data visualization.

Configure Tableau web data connector in Bot Insight
The web data connector in Tableau enables you to establish a secure connection with Automation 360 and
to extract, visualize, and analyze data from Bot Insight.
• Ensure that your user name is registered in the Control Room and that you have Bot Insight Admin

or the AAE_Admin role assigned to you.
• Ensure you have access to the desktop or public version of Tableau software.

Nota:  Single sign-on is not currently supported for Bot Insight. Connectors only work with the following
authentication mechanisms.
• Control Room database based authentication
• Active directory based authentication

The Web data connector in Tableau enables you to perform the following functions in Tableau:
• Authenticate and connect to the Control Room.
• Connect to Bot Insight APIs for business and operational information.
• Use business and operational information to create a data model.
• Create charts or graphs to represent the data.
• Create reports and share them with other users on Tableau.

1. Open Tableau.
2. Select Web Data connector from the Connect option in Data tab.
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3. In the Web Data Connector window, enter your Automation Anywhere URL in web data connector
field: <control room url>/tableau/Login.html

4. In the Automation Anywhere - Login window, enter the following information:
a) In the Control Room Version drop-down menu, select the version of the Control Room.
b) In the Control Room URL field, enter the URL or the host name of the Control Room.
c) In User Name and Password field, enter your Bot Insight user name and password.

5. Click Submit to connect to Bot Insight APIs.
6. Select either Business Information or Operational Information in the Bot Insight window.

If you are an AAE_Admin, you can choose between Audit APIs and Operations APIs.
7. Click Get Data.

Bot Insight API retrieves information from the server.
8. Click Update Now to gather all the data from Bot Insight in Tableau.

You can use the retrieved data from Bot Insight for data visualizations and analysis in Tableau.
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Riferimenti API
The Automation 360 platform provides a comprehensive suite of API capabilities that enable customers,
partners, and community developers to automate end-to-end processes using API.
Automation Anywhere APIs are Representational State Transfer (RESTful) APIs. You can use these
REST APIs allow you to manage, administer, and run automations programmatically from your own
application. By incorporating Automation Anywhere APIs into various software programs, you can simplify
application integration across different platforms and reduce development effort. By using the Automation
Anywhere APIs you can reduce development effort, as you can implement the APIs on different platforms.
Automation Anywhere APIs provide a secure communication gateway to interact and exchange data. You
can use the Automation Anywhere APIs to:
• Register your device using the Bot Agent API.
• Perform various functionalities in the Control Room using the Control Room APIs.

API di Control Room
The Automation Anywhere Control Room provides APIs that enable you to customize how you (and your
automations) interact with Automation Anywhere.
You use Control Room APIs to:
• Manage bot deployments
• Create and manage credentials in the Credential Vault
• Create and manage user accounts and roles
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• Create and manage queues

Per iniziare con le API Control Room

All requests must include an X-Authorization header with the JSON authentication token, or an
Authorization header with a Bearer token for requests to the Control Room. The following sections
provide details about the Control Room APIs available endpoints, methods, resources, authentication
protocols, parameters, and headers, as well as examples of common requests and responses.

Note:  The Bearer token is supported as of the Automation 360 v.27 release and later. It is unsupported
and ignored in any previous releases. You must obtain the Bearer token from our OAuth services. To
authorize your access, use either X-Authorization (using Authentication API) or Authorization (using
OAuth). You cannot use both in the same API.

The Control Room supports several API clients. To explore the Control Room APIs, download and install
Postman, then click https://www.postman.com/collections/bb5cd3541d29e192cd43 to download the Control
Room APIs collection. The following sections provide useful information about how to write a Control
RoomAPI request:
• Some APIs require you to filter, paginate, and sort the results to get the desired output. For more

information on filtering, pagination, and sorting, see Filtering, pagination, and sorting on page 2986.
• API response codes in the responses are described in the API response codes on page 2991.
• The Comparing Automation 360 and Enterprise 11 APIs on page 2992 compares the Enterprise 11 and

Automation 360 APIs.

To learn how to test Control Room APIs in Swagger and Postman, watch the following video:

Filtering, pagination, and sorting
The Control Room API supports filtering, pagination, and sorting for endpoints that return arrays of
resources.
The filtering mechanism filters the required resources, the sorting mechanism places the resources in
order; and the pagination mechanism then returns a specific range of those ordered resources. This topic
provides you the details to filter and sort the results of an API requests and also guides to handle the
pagination of large result sets returned from an API request.

Note:
• Sorting and filtering are supported for substrings. For example, if you want to search for bots or files

that have fin in their names, enter fin as the search criterion. All the bots and files that contain fin
in the names will be displayed, for example, Finance, Finder, DeltaFinance, and Dolfin.

• Wildcards are not supported for searching and filtering bots or files.

Filtering

Filtering allows you to apply Boolean condition against a collection of returned resources in order to subset
the collection to only those resources for which the condition is true. The most basic operation in an
Control Room API filters is to compare a field to a given value. It is possible to use equality comparison,
range comparison, or logical . Use the following operators to compare a field to a constant value.
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Operazione Descrizione Esempio

Equality comparison

eq Equals UserEmailAddress, eq
first.last@aa.com

ne Not Equals UserEmailAddress, ne
first.last@aa.com

Range comparison

lt Inferiore a (<) Quantity lt 1500

le Minore o uguale a Quantity le 1500

ge Maggiore o uguale a CreatedDateUtc ge 2021-03-15

gt Maggiore di CreatedDateUtc gt 2021-03-15

Logical

e E Field1 eq 'abc' and Field2 eq
'def'

o O Field1 eq 'abc' or Field2 eq 'def'

The filter query parameter allows you to apply basic, multiple, and convention oriented filters to
a request. The filters in the Control Room APIs are applied with single parameter or with multiple
parameters.
Single parameter filter
Single parameter filter allows the API request to select the responses by matching one or more members
of the response to the value passed in the query. The single parameter filter is represented in the following
image:

The JSON equivalent of the above image (single parameter filter) looks like:

{
  "filter": {
    "operator": "<NONE, lt, le, eq, ne, ge, gt, substring, and, or, not>",
    "field": "string",
    "value": "string"
  }
}
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For example, to list all the device pools that has a substring finance, use the following single parameter
filter:

POST http://{{ControlRoomURL}}/v2/devices/pools/list

{
   "filter":{
      "operator":"substring",
      "field":"name",
      "value":"finance"
   }
}

For more detailed sample on a single parameter filter, see Device Pools API .
Multiple parameter filter
Multiple parameter filter allows you to filter the results based on combining multiple conditions wrapped in
logical operands and and or.
• and: A binary operator that evaluates to true if all the conditions in the operands evaluate to true.
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• or: A binary operator that evaluates to true if atleast one of the conditions in the operands evaluate
to true.

The JSON equivalent of the above image (multiple parameter filter) looks like:

{
  "filter": {
    "operator": "<and, or>",
    "operands": [
      {
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        "operator": "<NONE, lt, le, eq, ne, ge, gt, substring, and, or,
 not>",
        "field": "string",
        "value": "string"
      },
      {
        "operator": "<NONE, lt, le, eq, ne, ge, gt, substring, and, or,
 not>",
        "field": "string",
        "value": "string"
      }
    ]
  }
}

For example, to list all the roles that has a substring Device, createdOn is after 2022-04-01, and
createdOn is before 2022-05-31, use the multiple parameter filtering with logical add operator as
follows:

POST http://{{ControlRoomURL}}//v1/usermanagement/roles/list

{
   "filter":{
      "operator":"and",
      "operands":[
         {
            "operator":"substring",
            "field":"name",
            "value":"Device"
         },
         {
            "operator":"gt",
            "field":"createdOn",
            "value":"2022-04-01T00:00:00.989Z"
         },
         {
            "operator":"lt",
            "field":"createdOn",
            "value":"2022-05-31T23:00:00.123Z"
         }
      ]
   }
   }

For more detailed sample on a single parameter filter, see User Management API .

Pagination

Pagination allows you to:
• Retrieve a limited collection of results.
• Offset a collection of results.

All Control Room APIs that returns a collection of records are paginated. API methods that support
pagination takes two (optional) parameters:
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Operazione Descrizione

offset The offset parameter controls the starting point within the collection of
response results. Default value is 0.

length The length parameter is the maximum number of records to retrieve
starting from the offset. Default value is 200.

The JSON snippet for pagination looks like:

"page":{ 
    "offset":5,
    "length":10
    }

For more detailed sample on a single parameter filter, see User Management API .

Sorting

Sorting allows you to order the results by any field, in ascending or descending order. For example, if you
are returning the roles, you can sort the roles by last modified date.

 "sort": [
    {
      "field": "string",
      "direction": "<asc, desc>"
    }

Direction
Type: Enum [ desc, asc ]
• asc = ascending (smallest to largest, 0 to 9, A to Z)
• desc = descending (largest to smallest, 9 to 0, Z to A)

For more detailed sample on a single parameter filter, see User Management API .

API response codes
Review the HTTP status codes of responses for Automation 360 APIs.

Status code Nome HTTP Descrizione

200 OK Operazione riuscita

201 Creato Success, for POST, PATCH or PUT requests.

202 Accettato Indicates that the request has been accepted
for processing, but the processing has not
been completed.

204 No content Success, for DELETE requests and some
PATCH requests.

400 Bad request Request URL or request parameters are
incorrect.

401 Autenticazione richiesta Provide authentication details.
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Status code Nome HTTP Descrizione

403 Unauthorized access The operation is not authorized.

404 Non trovato Control Room server did not find the requested
URL.

409 Conflitto The request could not be completed because
the code conflicts with the current state of the
resource, for example, a duplicate entry.

500 Internal server error Indicates that the server encountered a
problem. Clear the cookies and cache, and
then reload the page.

Comparing Automation 360 and Enterprise 11 APIs
Compare Automation 360 and Enterprise 11 APIs to understand the contract changes when you migrate
from Enterprise 11 to Automation 360.

API details Enterprise 11 Automation 360

Authentication API: Use this API to obtain the authentication token. The token is then used for
all subsequent API calls.

Method POST POST

Endpoint v1/authentication v1/authentication

Request body changes Non applicabile No change

Response body changes Non applicabile • Multi-factor authentication is
not supported

• Automation 360 response
returns the tenantUuID

Auto login credentials API: Use this API to set the Windows credentials for a Bot Runner. These
credentials are used for automatically login (auto-login).

Method POST PUT

Endpoint v1/credentialvault/
external/credentials/
loginsetting

v2/credentialvault/
loginsetting

Request body changes Non applicabile Endpoint version change

Response body changes Non applicabile Message displayed after
successfully updating the
credentials: Credentials
updated for <username>.
Enterprise 11 displays this
message: Credentials were
successfully updated.

Automation management API: Use this API to create automations (schedule bots), and edit and
delete automations.
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API details Enterprise 11 Automation 360

Method POST, PUT, and DELETE POST, PUT, GET, and DELETE

Endpoint v1/schedule v1/schedule

Request body changes Non applicabile Minor change in request body to
pass bot input variables

Response body changes Non applicabile Detailed response with bot
input variable details

User Management API: Use this API to create, edit, and delete users and roles.

Method POST, PUT, GET, and DELETE POST, PUT, GET, and DELETE

Endpoint v1/usermanagement v1/usermanagement

Request body changes Non applicabile No change

Response body changes Non applicabile No change

Migration API: Use this API to migrate bots from Enterprise 11 or Enterprise 10 to Automation
360

Method GET and POST GET and POST

Endpoint • v1/migration
• v2/migration

v2/migration

Response body changes Non applicabile • Endpoint version change
• APIs used to connect to

the Enterprise 10 database
to migrate users, roles,
schedules, and bots

Request body changes Non applicabile Because the endpoints and
request body are different, the
response body is also different.

Manual Dependency API: Use this API to add or remove a dependency (data files and such) to
or from a bot.

Method POST and DELETE Non disponibile

Endpoint v1/files/
manualdependencies/

Non disponibile

Request body changes Non applicabile Non disponibile

Response body changes Non applicabile Non disponibile

Repository Management API: Use this API to get bots and files from the Control Room
repository.

Method POST, DELETE, and GET POST, DELETE, and GET

Endpoint v1/repository v1/repository

Request body changes Non applicabile Additional APIs added to get
folder permissions

Response body changes Non applicabile No change

© 2023 Automation Anywhere. All rights reserved.     2993



    Automation Anywhere - Riferimenti API

API details Enterprise 11 Automation 360

File Dependency API: Use this API to get the file dependency metadata to run and schedule
bots.

Method GET Non disponibile

Endpoint v1/files/
manualdependencies/

Non disponibile

Request body changes Non applicabile Non disponibile

Response body changes Non applicabile Non disponibile

Bot Lifecycle Management (BLM) API: Use this API to move (export or import) bots and
dependent files across different Control Room environments.

Method POST POST

Endpoint v1/blm v2/blm

Request body changes Non applicabile • Endpoint version change
• You cannot choose

dependencies when
exporting and importing

Response body changes Non applicabile No change

Audit API: Use this API to get audit information about the product.

Method POST POST

Endpoint v1/audit v1/audit

Request body changes Non applicabile No change

Response body changes Non applicabile No change

Two-factor Authentication (2FA) API: Use this API to generate a 2FA token

Method GET and POST Non disponibile

Endpoint v1/mfa Non disponibile

Request body changes Non applicabile Non disponibile

Response body changes Non applicabile Non disponibile

Credential Vault API: Use this API to create, edit, and delete credentials and lockers.

Method POST, PUT, GET, and DELETE POST, PUT, GET, and DELETE

Endpoint v2/credentialvault v2/credentialvault

Request body changes Non applicabile No change

Response body changes Non applicabile No change

Bot Execution Orchestration API: Use this API to get the repository, automations, and devices
list.

Method POST POST, PUT, GET, and DELETE

Endpoint v2/automations/deploy v3/automations/deploy
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API details Enterprise 11 Automation 360

Request body changes Non applicabile Bot deployment includes run-as
users

Response body changes Non applicabile Returns deploymentID.
Enterprise 11 API response
returns automationID.

License API: Use this API to get product license information.

Method GET GET

Endpoint v2/license v2/license

Request body changes Non applicabile No change

Response body changes Non applicabile Additional APIs added to
update with license server and
additional details

Workload Management (WLM) API: Use this API to create, edit, and delete workload queues,
templates, and work items.

Method POST, PUT, GET, and DELETE POST, PUT, GET, and DELETE

Endpoint v2/wlm v3/wlm

Request body changes Non applicabile No change

Response body changes Non applicabile More APIs to manage WLM
entities

Bot Insight API: Use this API to get Bot Insight data for an automation.

Method POST, GET, and DELETE POST, GET, and DELETE

Endpoint v2/botinsight/data/api v2/botinsight/data/api

Request body changes Non applicabile No change

Response body changes Non applicabile No change

Bot Insight JSON API: Use to get business insights for an automation.

Method GET Non applicabile

Endpoint v2/botinsight/data/api Non applicabile

Request body changes Non applicabile Non applicabile

Response body changes Non applicabile Merged with Bot Insight API

Related concepts
API di Control Room on page 2985
The Automation Anywhere Control Room provides APIs that enable you to customize how you (and your
automations) interact with Automation Anywhere.

Configure the Control Room
Before you start creating workflows for bot deployment and workload management using Control Room
APIs, ensure you complete specific prerequisites and steps in the Control Room.
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Ensure you have following licenses and permissions:
• One or more Bot Creator and unattended Bot Runner licenses.
• Control Room admin credentials to view, create, and configure users, roles, and device pools.
• The Create device pools feature permission or the AAE_Pool Admin role must be assigned to you.

Follow these steps to configure your Control Room with users, roles, and bots.
1. Log in to the Control Room as an admin.
2. Create a Control Room user.

Ensure that the user is assigned the AAE_BASIC role.
Create a user on page 2684

3. Create a custom role to map the users you created to Bot Runners and Bot folders.
a) In the Features tab, ensure you select these permissions: View my Scheduled Bots,

Schedule my bots to run, Run my Bots, View my Bots, and Generate my API Key.
b) In the Automation tab, expand the Bots folder and select the root folder or subfolders you want

to provide access for use. Ensure you select these permissions: Run and schedule and View
content.

c) In the Run as tab, select one or more Bot Runners from the list of Available bot runners.
d) In the Users tab, select the new user created in Step 1 to assign the custom role to this new

user.

4. Create a new device pool.
In the Consumers tab, ensure you select the custom role you created in Step 3.
Crea pool di dispositivi on page 2636

5. Log in to the Control Room as a Bot Creator and create bots to automate routine business tasks.
Build a Go be Great bot on page 2050
Ensure you check in the bots in the Bot folder or folders selected when creating the custom role (Step
3). Check in a bot on page 1997

Roles and permissions
Assign roles from the Automation 360 Administration user interface or through the User Management API
to enable users to access features. You can assign a system-created role or create a custom role with
specific permissions.
Roles are a logical container for permissions and have interdependencies with bots, users, and licenses.
Users with the AAE_Admin role can create custom roles and assign roles to users.
Related concepts
Analisi del codice on page 2782
L'analisi del codice consente di valutare un programma senza eseguirlo. In Automation 360, the code
analysis feature analyzes the code and displays a list of violations based on a set rules. Puoi rivedere e
correggere eventuali errori di codifica o stilistici per l'automazione.
Related reference
Autorizzazioni per le funzioni di un ruolo on page 2694
Un utente con il ruolo AAE_Admin o un ruolo personalizzato con l'autorizzazione Gestisci ruoli può
creare e assegnare ruoli agli utenti, per fornire loro l'accesso a funzionalità e operazioni.
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Ruoli creati dal sistema
Automation 360 include ruoli predefiniti che non possono essere modificati o eliminati. Each role has the
standard permissions, plus the permissions necessary to perform the tasks within the scope of that role.

Autorizzazioni standard

Tutti i ruoli creati dal sistema includono le seguenti autorizzazioni:
• Visualizza dashboard
• Visualizza la mia Attività in corso
• Gestisci le mie credenziali e i miei armadietti
• Crea attributi standard per una credenziale (ad eccezione dei ruoli Discovery Bot)
• Visualizza e gestisci i miei esecutori di bot, creatori di bot e dispositivi
• Visualizza e gestisci le mie code
• Visualizza le informazioni di base degli utenti e dei ruoli

Autorizzazioni per l'amministrazione
Enable users to create and manage users and roles, to manage and update migrations, and to install
Control Room licenses.
You will be able to use the Retrieve role by ID. See User Management API  endpoint with the role ID to
retrieve the permissions assigned to any system or user defined roles.

Users and roles permissions

Azione Tipo di risorsa Descrizione

usermanagement usermanagement Allows you to only view all other users in the
system. You cannot create, edit, or delete users.

Note:  Devi assegnare questa autorizzazione
prima di assegnare le autorizzazioni createuser,
updateuser o deleteuser.

deleteuser usermanagement Allows you to delete other users the Control Room.

createuser usermanagement Allows you to create new users in the Control
Room.

updateuser usermanagement Allows you to edit all users in the system.

rolesview rolesmanagement Gli utenti con questa autorizzazione sono in grado
di visualizzare i ruoli in Control Room.

Note:  Devi assegnare questa autorizzazione prima
di assegnare l'autorizzazione rolesmanagement.

rolesmanagement rolesmanagement Allows you to view and manage all roles in the
Control Room.
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Azione Tipo di risorsa Descrizione

viewuserrolebasicinfousermanagement Allows you to view basic information on users and
roles.

Migration permissions

Azione Tipo di risorsa Descrizione

visualizzare migrazione Allows you to view new migrations, but not run
them

Note:  Devi assegnare questa autorizzazione prima
di assegnare l'autorizzazione manage migrazione

manage migrazione Allows you to view and run new migrations

updatestatus migrazione Allows Bot Runner Run-as user to update the bot
conversion status in the Control Room

Licenses permissions

Azione Tipo di risorsa Descrizione

licensemanagementlicensemanagement Allows you to view the license details for the
Control Room.

licenseinstall licensemanagement Allows you to install Automation 360 licenses for the
Control Room.

licenseuserallocationlicensemanagement Allows you to assign device licenses to other users.

Note:  Only a user with the AAE_Admin role has the ability to view and manage settings in the Control
Room. Consulta Ruoli creati dal sistema on page 2997.

Runtime Client Management permissions

Azione Tipo di risorsa Descrizione

runtimeclientsmanagementruntimeclientsmanagement Allows you to use the device mentioned in the
resourceId for deployment. This permission is
assigned when you are assigned a default device.

accessresourceany runtimeclientsmanagement Allows you to use any device for deployment. This
permission is currently granted for all users with
AAE_ADMIN role.

1 Not available in the UI and is seen only in the API response.
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Global Values Permissions

Azione Tipo di risorsa Descrizione

manageuserscopevaluesglobalvalues Manage tenant level global values, given to
AAE_Admin only. This cannot be given to any
custom role at the moment.

managetenantscopevaluesglobalvalues Not used, created for future purpose.

other permissions

Azione Tipo di risorsa Descrizione

systemadmin system This permission is given to AAE_Admin only.
It is a system call and cannot be called manually.
This permission is used to count the number of
pages consumed against the entitled pages for the
IQ bot application.
It fetches a list of all the users with basic details
and license information.

visualizzare settings View settings.

Note:  You will be allowed to view settings only
with the system-created Admin role to view
Settings.

tutta botrunners Allows you to use any runAsUser for deployment.
This permission is currently granted for all users
with AAE_ADMIN role.

operationroom operationroom Legacy, not used and will be removed from the
future releases.

manage mfa Legacy, not used and will be removed from the
future releases.

API permissions
Enables access to Bot Insight APIs and the ability to generate an API key.

Azione Tipo di risorsa Descrizione

botinsightapi api Consente all'utente di accedere alle API REST di Bot
Insight per accedere ai dati registrati da Control Room e
da un'attività durante le sessioni di produzione.
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Azione Tipo di risorsa Descrizione

generateapikey api Generate an apiKey that can be used in the
Authentication API.

Note:  Without the generateapikey permission,
use APIs by authenticating using their username and
password.

coeadmin botinsightapi Reserved. Not used for now and will be used when COE
dashboard is available in A360. Allows you to access the
COE dashboard when it is made available in A360.

accessreportingapi iqbotapi Allows you to access reporting details via an API.

accessuploadanddownloadapiiqbotapi Allows you to upload a document and download the
digitized result via an API.

accessnlpapi iqbotapi Allows you to access natural language processing
capabilities of the IQ Bot portal via an API.

Audit log permissions
View logs and details to record user activities. Enable users to view logs from the Control Room.

Azione Tipo di risorsa Descrizione

recentactivities recentactivities Allows you to view all audit log activity for the Control
Room

archiveaudit recentactivities Allows you to archive all audit log activity for the Control
Room

Automation Anywhere Robotic Interface (AARI) permissions
Assign AARI permissions to a custom role.

Azione Tipo di risorsa Descrizione

aaricrossteamreadaari Visualizza tutti i team e i membri del team

aaricrossprocessreadaari Visualizza tutti i processi, i membri del team e i gestori

aariteammanagementaari Crea e visualizza team, modifica nomi, descrizioni e tag di
processo. Aggiungi nuovi team, membri del team e processi
assegnati

aaritaskmanagementaari Invia e visualizza le attività dai processi assegnati al team

aaricasemanagementaari Crea e visualizza le richieste dai processi assegnati al team

aariglobalcasemanagementaari Visualizza le richieste e le attività di processo.

Note:  This permission does not grant the ability to create a
request or submit a task
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Azione Tipo di risorsa Descrizione

aariglobalprocessmanagementaari Visualizza i processi pubblici archiviati, i gestori e i team
assegnati, modifica i tag di processo e assegna gestori e team

Note:  This permission does not grant the ability to create a
process.

aariglobalteammanagementaari Visualizza i team e gli utenti assegnati, modifica i nomi e le
descrizioni dei team. Add new processes, managers and users
to a team

Note:  This permission does not grant the ability to create a
team.

aarischeduler aari Allows users to be used as AARI scheduler

Bot and bot credential permissions
Enables users to access features for managing bots and the credentials used by bots.

Autorizzazioni per Bots

Azione Tipo di risorsa Descrizione

visualizzare repositorymanager Allows you to view the bots they created and bots that
were assigned to them.

Note:  Devi assegnare questa autorizzazione prima di
assegnare qualsiasi altra autorizzazione bots.

esegui repositorymanager Allows you to run the bots they created and bots that
were assigned to them.

esporta repositorymanager Allows you to export bots and related bot dependencies
for which they have download permission.

Importa repositorymanager Allows you to import bots and bot dependencies for
which they have upload permission.

createfolders repositorymanager Consente agli utenti di creare sottocartelle nelle cartelle
a cui hanno accesso.

renamefolders repositorymanager Allows you to rename the folders they have access to.

Note:  Solo le cartelle vuote possono essere rinominate.

cancelcheckout repositorymanager Allows you to cancel bot checkout and unlock the file
from the public repository.

forceunlock repositorymanager Allows you to unlock locked bots.
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Azione Tipo di risorsa Descrizione

accessresourceany repositorymanager Allows you to get permissions to the resources. Ad
esempio,
runtimeclientsmanagement, pool, queue and so on.

setproductionversion repositorymanager Allows you to set the production version of bots.

tutta repositorymanager Allows you to get all the repository permissions.

gitrestore repositorymanager Allows you to get git restore permissions.

Credentials and lockers permissions

Azione Tipo di risorsa Descrizione

managecredentials credenziali Allows you to create, edit, and delete their own
credentials. Inoltre, l'utente può interagire con le
credenziali dai relativi lockers assegnati.

Note:  Per impostazione predefinita, tutti i ruoli
dispongono di questa autorizzazione.

creare armadietto Allows you to create and manage their own lockers.

consume armadietto Allows you to consume a locker locker

createstandard credentialattribute Allows you to create a standard attribute for a credential
that is shared across all users of that credential .

updateany credentialattributevalueAllows you to view and edit their own masked attributes.

botautologinapi credentialattributevalueAllows you to automate the login process to run bots
remotely.

addcredential credentialmanager

updatecredential credentialmanager

deletecredential credentialmanager

Legacy, not used and will be removed from the future
releases.

Note:  Un utente con il ruolo AAE_Locker Admin può visualizzare tutte le credenziali e gli armadietti in
Control Room. Consulta Ruoli creati dal sistema on page 2997.

Autorizzazioni per Bot Store
Enables users to view and manage Bot Store packages.

Azione Tipo di risorsa Descrizione

visualizzare botstore Allows you to view Bot Store.

addfrom botstore Allows you to add bot packages from Bot Store to their
Control Room private workspace.
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Azione Tipo di risorsa Descrizione

invia botstore Allows you to submit bot packages to Bot Store.

Dashboard and activity permissions
Enables all users to view dashboards. Activity permissions enable users to view, manage, and schedule bot
activities.

Dashboard and Activity Permissions

Azione Tipo di risorsa Descrizione

visualizzare dashboard View dashboard.

Note:  Per impostazione predefinita, tutti i ruoli dispongono di
questa autorizzazione.

myschedule taskscheduling All users can view their own activity.

Note:  Per impostazione predefinita, tutti i ruoli dispongono di
questa autorizzazione.

managemyscheduletaskscheduling All users can pause, resume, or cancel their own activity and
move their finished activities to history.

manageeveryonescheduletaskscheduling A user can monitor ongoing automations where a user has
either run or schedule access on the respective bot. The user
can monitor and manage ongoing automations.

visualizzare taskscheduling Users can see their scheduled bots regardless of which user
scheduled the bot.

addschedule taskscheduling It requires permission to view and manage Bot Runners.

updateschedule taskscheduling Users can edit their scheduled bots, even if the bots are
scheduled by a different user.

deleteschedule taskscheduling Users can delete schedules for any of their bots regardless of
which users scheduled the bot.

manageallmyfolderschedulestaskscheduling Users can view, edit, and delete all the schedules on the bot
folders that the user has access to. Ciò include i programmi
creati dall'utente e i programmi creati da altri utenti.

manageallschedulestaskscheduling Users can view, edit, and delete all the schedules in the system.
Ciò include i programmi creati dall'utente e i programmi creati
da altri utenti.

setautomationprioritytaskscheduling Users can set the automation priority to high from the default
medium. Automations with high priority are deployed ahead of
automations with medium and low priority.

everyonescheduletaskscheduling Users can monitor those ongoing automations where the they
have either run or schedule access on the respective TaskBot.
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Devices permissions
Enable you to register, view, and manage devices used to run bots.

Azione Tipo di risorsa Descrizione

register dispositivi Allows you to register a localhost device.

tutta dispositivi Allows you to view and manage all devices in the Control Room.

eliminare dispositivi Allows you to delete devices that they registered.

modificare dispositivi Allows you to edit the devices that they have permission to see.
Allows you to view and manage all (registered and non-
registered) devices from a specific accessible group.

Note:  To view and manage registered and non-registered
devices,
• The Control Room administrator must grant access to

manage a specific set of devices.
• You must select Devices from my device pool(s) to edit

devices from device pools and Run as user(s) default
device to edit Run as user(s) default device options in the
Edit devices permission.

visualizzare dispositivi Allows you to view and manage Bot Creators, Bot Runners, and
device pools.

Note:  Per impostazione predefinita, tutti i ruoli dispongono di
questa autorizzazione.

attestcredentials dispositivi Allows you to deploy the bot during a session on the user's
device without system password.

creare pool Allows you to create and manage their own device pools.

Note:  A user with the AAE_Pool Admin role is able to manage all device pools in the Control Room.
Consulta Ruoli creati dal sistema on page 2997.

Autorizzazioni per Discovery Bot
Enable users to view or manage Discovery Bot processes, recordings, aggregations, and opportunities.
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Process permissions

Azione Tipo di risorsa Descrizione

viewprocess processdiscovery Consente agli utenti di visualizzare i processi assegnati.

Note:  Questa è l'autorizzazione standard. Devi
assegnare questa autorizzazione prima di assegnare
qualsiasi altra autorizzazione process discovery.

viewallprocess processdiscovery Consente agli utenti di visualizzare tutti i processi
definiti.

editprocess processdiscovery Consente agli utenti di creare e modificare i processi.

Recording permissions

Azione Tipo di risorsa Descrizione

viewrecording processdiscovery Consente agli utenti di visualizzare la propria
registrazione.

Note:  Devi assegnare questa autorizzazione prima di
assegnare una qualsiasi di quelle riportate di seguito.

createrecording processdiscovery Allows users to run recorder and create recording.

editrecording processdiscovery Consente agli utenti di modificare le proprie
registrazioni.

deleterecording processdiscovery Consente agli utenti di eliminare le proprie registrazioni.

viewallrecording processdiscovery Consente agli utenti di visualizzare tutte le registrazioni.

editallrecording processdiscovery Allows users to edit all recordings.

Aggregation permissions

Azione Tipo di risorsa Descrizione

viewmanualaggregationprocessdiscovery Consente agli utenti di visualizzare le proprie
aggregazioni.

viewallaggregations processdiscovery Consente agli utenti di visualizzare tutte le aggregazioni.

createdeletemanualaggregationprocessdiscovery Consente agli utenti di creare ed eliminare aggregazioni.

updatemanualaggregationprocessdiscovery Consente agli utenti di aggiornare le aggregazioni.

viewsystemaggregationprocessdiscovery Consente agli utenti di visualizzare le aggregazioni di
sistema.
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Opportunity permissions

Azione Tipo di risorsa Descrizione

viewopportunity processdiscovery Allows users to view opportunities within an assigned
process.

Note:  You must assign this permission before assigning
any of the opportunity permissions.

editopportunity processdiscovery Allows users to edit opportunities within an assigned
process.

viewallopportunity processdiscovery Allows users to view all the opportunities.

createdeleteopportunityprocessdiscovery Consente agli utenti di creare ed eliminare le opportunità
esistenti nel processo assegnato.

converttobot processdiscovery Consente agli utenti di convertire un'opportunità in un
bot.

exportopportunity processdiscovery Consente agli utenti di esportare un'opportunità.

Event triggers permissions
Enable users to run bots automatically depending on a specific event, such as a new window opening. You
can limit users ability to only view or to view and manage triggers.

Azione Resource type Descrizione

visualizzare eventtriggers Consente agli utenti di visualizzare i trigger di evento.

manage eventtriggers Consente agli utenti di visualizzare e gestire i trigger di
evento.

managemytriggers eventtriggers Allows users to view and manage event triggers from
their private repository, on their local devices.

Additionally, you must enable the view packages permission as well:

Azione Resource type Descrizione

visualizzare packagemanager Allows users to view packages

Autorizzazioni per IQ Bot
Consente agli utenti di visualizzare le autorizzazioni per IQ Bot, creare e gestire istanze di apprendimento,
importare ed esportare domini, nonché gestire le impostazioni di configurazione e migrazione di IQ Bot.
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Autorizzazioni per IQ Bot

Azione Tipo di risorsa Descrizione

viewiqbot iqbot Consente di visualizzare i dashboard predefiniti nel
portale IQ Bot.

Note:  Devi assegnare questa autorizzazione prima di
assegnare una qualsiasi di quelle riportate di seguito.

visualizzare iqbotpages Permette di visualizzare le pagine di iqbot con licenza

utilize iqbotpages Permette di utilizzare le pagine di iqbot con licenza

Autorizzazioni per l'istanza di apprendimento

Azione Tipo di risorsa Descrizione

viewlearninginstance viewiqbot Consente di visualizzare le proprie istanze di
apprendimento nel portale IQ Bot.

Note:  Devi assegnare questa autorizzazione prima di
assegnare qualsiasi altra autorizzazione per le istanze di
apprendimento.

viewlearninginstancefromsameroleviewlearninginstance Consente di visualizzare istanze di apprendimento create
da altri utenti con lo stesso ruolo nel portale IQ Bot.

assignroletolearninginstancesviewlearninginstance Consente di assegnare alcuni ruoli personalizzati a
un'istanza di apprendimento.

viewalllearninginstancesviewlearninginstance Consente di visualizzare tutte le istanze di
apprendimento nel portale IQ Bot.

launchvalidatior viewlearninginstance Consente di accedere al Validator IQ Bot per esaminare
e aggiornare i documenti con eccezioni.

createlearninginstancesviewlearninginstance Consente di creare istanze di apprendimento nel portale
IQ Bot.

editlearninginstances viewlearninginstance Consente di modificare le istanze di apprendimento nel
portale IQ Bot.

deletelearninginstancesviewlearninginstance Consente di eliminare le istanze di apprendimento nel
portale IQ Bot.

sendlearninginstancestoprodviewlearninginstance Consente di inviare le istanze di apprendimento in
produzione nel portale IQ Bot.

trainlearninginstancegroupsviewlearninginstance Consente di addestrare i gruppi di istanze di
apprendimento nel portale IQ Bot.

© 2023 Automation Anywhere. All rights reserved.     3007



    Automation Anywhere - Riferimenti API

Autorizzazioni per i domini

Azione Tipo di risorsa Descrizione

viewdomain viewiqbot Consente di visualizzare tutti i domini nel portale IQ Bot.

Note:  Devi assegnare questa autorizzazione prima di
assegnare qualsiasi altra autorizzazione al dominio.

createdomains viewdomain Consente di creare domini nel portale IQ Bot.

editdomains viewdomain Consente di modificare i domini nel portale IQ Bot.

importdomains viewdomain Consente di importare domini nel portale IQ Bot.

exportdomains viewdomain Consente di esportare domini nel portale IQ Bot.

deletedomains viewdomain Consente di eliminare domini nel portale IQ Bot.

Autorizzazioni per l'amministrazione

Azione Tipo di risorsa Descrizione

viewadministration viewiqbot Consente di accedere alla scheda Amministrazione nel
portale IQ Bot.

Note:  Devi assegnare questa autorizzazione
prima di assegnare qualsiasi altra autorizzazione di
amministrazione.

viewandmanagesettingsviewadministration Consente di gestire impostazioni di configurazione
avanzate del portale IQ Bot.

viewandmanagemigrationviewadministration Consente di accedere all'utilità di migrazione per
esportare e importare istanze di apprendimento nel
portale IQ Bot.

MetaBot permission
MetaBots are obsolete in Automation 360. However, this permission is valid to ensure that all functionality
previously available is supported in Automation 360.

Access to MetaBot Designer Permission/feature ID is not available.
Bot Creator users can access MetaBot Designer to
view, create, and update MetaBots.

Note:  This feature is available for internal use only.

Package manager permissions
Enable users to view and manage packages.
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Azione Tipo di risorsa Descrizione

visualizzare packagemanager Allows you to view packages.

manage packagemanager Allows you to view and manage packages.

Autorizzazioni per il carico di lavoro
Enable you to create and manage workitems, workitem models, queues, and automations in the Control
Room.

Azione Tipo di risorsa Descrizione

myschedule taskscheduling Allows you to view and manage their own schedules.

visualizzare coda Allows you to view their own queues.

creare coda Allows you to create and manage their own queues.

calculate sla Allows you to calculate workload Service Level
Agreements (SLA).

visualizzare workload Legacy, not used and will be removed from the future
releases.

accessresourceany coda Legacy, not used and will be removed from the future
releases.

Note:  A user with the AAE_Queue Admin role has all the above permissions. In addition, the
AAE_Queue Admin is able to manage all the queues in the Control Room. Consulta Ruoli creati dal sistema
on page 2997.

Bot Agent API: Auto registration
Automatically register and connect your device to a Control Room by using the Auto registration API.
This API uses the generic registration token from the auto-registration.properties file to
register the device in the specified Control Room URL. You cannot autoregister the device if the
Control Room URL is not available in the auto-registration.properties file. The auto-
registration.properties file must be available on your local system, and you must not delete the
file after the registration is complete.

Note:  To register the device from the command line or API, you must set the
AA_DELAY_REGISTRATION_UNTIL_LOGIN MSI parameter.

Richiesta

POST http://127.0.0.1:22113/v1/registration/auto

Corpo della richiesta:

{
    "url": "https://{controlroom url}",
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    "userName": "dpcreator"
}

Request parameters

Parametro Tipo Obbligatorie Descrizione

url Stringa Sì Specify the Control Room URL to autoregister the
device.

nomeUtente Stringa No Specify the Control Room user to associate the device
as the default device.

Risposta

{
  "result": "REGISTERED",
  "deviceId": "11",
  "crUrl": "control_room_url",
  "userName": "dpcreator"
  "installationType": "SYSTEM_WIDE",
  "crSwitchAllowed": "false",
}

Response parameters

Parametro Tipo Descrizione

result Stringa Status of the device registration.

deviceId Numero Unique ID of the device the Bot Agent is installed on.

crUrl Stringa The Control Room URL where the device is autoregistered.

nomeUtente Stringa The username for which the device is associated as default device.

installationType Stringa The type of installation that is performed.

crSwitchAllowed Stringa Indicates whether the device can be registered on a different Control Room.

The REST API responds to each request with an HTTP response code. For response codes, see API
response codes on page 2991.
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